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Kapitel 1: Willkommen bei Pro Tools

Willkommen bei Pro Tools® – einem Produkt von 
Avid® Technology. Pro Tools bietet eine 
leistungsstarke integrierte Lösung für 
mehrspuriges digitales Audio- und MIDI-
Sequencing, durch die Sie alle erforderlichen 
Funktionen für Aufnahme, Arrangement, 
Komposition, Editing, Mix und Mastering von 
professionellem Audio und MIDI für Musik, 
Video, Film und Multimedia erhalten.

Systemanforderungen und 
Kompatibilitätsinformationen
Avid kann die Kompatibilität und technische 
Unterstützung nur für Hardware- und 
Softwarekomponenten zusichern, 
die entsprechend geprüft und genehmigt wurden. 

Die kompletten Systemanforderungen und eine 
Liste der qualifizierten Computer, 
Betriebssysteme, Festplatten und Geräte von 
Drittanbietern finden Sie auf der Website:

www.avid.com/compatibility

Informationen zur Website 
www.avid.com
Auf der Avid-Website (www.avid.com) finden Sie 
alle Informationen, die Sie benötigen, um bei der 
Arbeit mit Ihrem Pro Tools-System die besten 
Ergebnisse zu erzielen. Die Website bietet unter 
anderem folgende Inhalte und Services: 

Produktregistrierung – registrieren Sie Ihr 
Produkt online. 

Support und Downloads – Kontaktaufnahme 
mit Avid Customer Success (technischer 
Kundendienst), Download von Software-Updates 
und der aktuellsten Online-Dokumentation, 
Kompatibilitätslisten mit Angabe der 
Systemanforderungen, Online-Suche in der 
Knowledge Base, Austausch von Informationen in 
der weltweiten Pro Tools-Community über die 
„User Conference“. 

Training und Fortbildung – Online-Kurse zum 
Selbststudium und Fortbildungskurse in 
zertifizierten Pro Tools-Trainingsinstituten. 

Produkte und Entwickler – erfahren Sie mehr über 
Avid-Produkte, unsere Entwicklungspartner und 
deren Plug-Ins, Anwendungen und 
Hardwarelösungen oder laden Sie Software-
Demoversionen herunter. 

News und Events – News zu Avid oder 
Anmeldung für eine Pro Tools-Demoversion.

http://www.avid.com/compatibility
http://www.avid.com
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Konventionen in der 
Pro Tools-Dokumentation
In den Pro Tools-Handbüchern werden für 
Menüoptionen und Tastatur-/Mausbefehle die 
folgenden Konventionen verwendet
:

Die Namen von Befehlen, Optionen und 
Einstellungen auf dem Bildschirm werden in einer 
anderen Schriftart dargestellt.

Mit folgenden Symbolen werden besonders 
wichtige Informationen hervorgehoben:

Konvention Vorgang

File > Save Wählen Sie im File-
Menü die Save-Option

Strg + N Drücken Sie gleichzeitig 
die Strg-Taste und die 
Taste N

Strg + Klicken Halten Sie die Strg-Taste 
gedrückt und klicken Sie 
mit der Maus

Rechtsklick Klicken Sie mit der 
rechten Maustaste

Anwendertipps sind nützliche Hinweise 
für eine optimale Nutzung Ihres Pro Tools- 
Systems.

Wichtige Hinweise enthalten Informationen, 
die sich auf die Daten einer Pro Tools-
Session oder auf die Leistung Ihres 
Pro Tools-Systems beziehen.

Tastenkombinationen zeigen Ihnen nützliche 
Tastatur- oder Maus-Kombinationen.

Querverweise verweisen auf themenverwandte 
Abschnitte in diesem Handbuch und in 
anderer Avid-Dokumentation.
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Kapitel 2: Pro Tools-Konzepte

Vor der Verwendung von Pro Tools sollten Sie 
sich mit den Pro Tools-Konzepten vertraut 
machen. Diese Konzepte bilden die Grundlage für 
die Bedienung und den Betrieb von Pro Tools.

Festplattenaufnahme
Bei der Aufnahme auf Festplatte wird ein 
nichtlineares Medium mit Direktzugriff 
verwendet, das heißt, Sie haben sofortigen Zugriff 
auf jede beliebige Stelle einer Aufnahme, ohne 
vor- oder zurückspulen zu müssen.

Darin unterscheidet sich diese Technik von der 
Aufnahmetechnik mit einem Tonbandgerät – einem 
linearen Medium, bei dem Sie das Band vor- oder 
zurückspulen müssen, wenn Sie eine bestimmte 
Stelle anhören wollen. Um bereits vorhandenes 
Material in einem linearen System neu zu 
arrangieren oder zu wiederholen, sind eine erneute 
Aufnahme oder weitere Schnitte erforderlich. 

Nichtlineare Systeme haben eine ganze Reihe von 
Vorteilen. Sie können Abschnitte einer Aufnahme 
problemlos neu anordnen oder wiederholen, indem 
Sie sie einfach in einer anderen Reihenfolge oder 
mehrfach von der Festplatte lesen lassen. Hinzu 
kommt, dass die vorgenommenen Änderungen 
nicht destruktiv sind, das Originalmaterial auf der 
Festplatte bleibt also intakt.

Nichtlineares Editieren
Pro Tools ist ein nichtlineares Editing-System, 
das Ihnen die nichtdestruktive Neuanordnung und 
Mischung von Aufnahmen ermöglicht. 
„Nichtlinear“ bedeutet, dass Sie sämtliche Audio-, 
MIDI- oder Videodaten im Edit-Fenster von 
Pro Tools ausschneiden, kopieren, einfügen, 
verschieben, löschen, zuschneiden und 
anderweitig umstellen können. 

Nichtlineare Bearbeitung bietet gegenüber dem 
Dubbing (Neuaufnahme) und dem Schneiden von 
Magnetband deutliche Vorteile. Sie bietet Ihnen 
größtmögliche Flexibilität und Sicherheit beim 
Schneiden und Arrangieren, da vorgenommene 
Änderungen rückgängig gemacht werden können. 
Zusätzlich kommt es mit der nicht linearen 
Bearbeitung in Pro Tools nie zu einem Verlust der 
Audioqualität wie bei Bändern.
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Audio Engines
Pro Tools kann mit der Avid Audio Engine (nur 
Audio-Hardware von Avid), mit Core Audio (nur 
Mac mit Audio-Hardware anderer Hersteller) oder 
ASIO (nur Windows mit Audio-Hardware anderer 
Hersteller) Audio zwischen der Anwendung und 
Ihrer Audio-Hardware streamen.

Avid Audio Engine

Die Avid Audio Engine (AAE) ist ein Echtzeit-
Betriebssystem für die digitale Aufnahme, 
Wiedergabe und Verarbeitung mit Pro Tools und 
Audio-Hardware von Avid. AAE wird zusammen 
mit Pro Tools automatisch auf dem System 
installiert. AAE übernimmt einen großen Teil der 
Festplattenaufnahmen, der digitalen 
Signalverarbeitung und der Mix-Automation für 
Pro Tools und andere Produkte von Avid und 
seinen Entwicklungspartnern.

Core Audio

Apples Core Audio bietet eine Audioverbindung 
zwischen Software-Anwendungen und Audio-
Hardware unter Mac OS X. Pro Tools-Software 
kann Audio-Interfaces mit unterstützten Core Audio-
Treibern für Wiedergabe und Aufnahme mit bis zu 
32 Ein-/Ausgangskanälen verwenden.

ASIO

Steinbergs ASIO (Audio Stream Input/Output) 
bietet eine Audioverbindung zwischen Software-
Anwendungen und Audio-Hardwar e unter 
Windows. Pro Tools-Software kann Audio-Interfaces 
mit unterstützten ASIO-Treibern für Wiedergabe und 
Aufnahme mit bis zu 32 Ein-/Ausgangskanälen 
verwenden.

Avid Video Engine
Pro Tools verwendet die Avid Video Engine (AVE) 
zur Echtzeitwiedergabe von digitalem Video. AVE 
wird automatisch mit Pro Tools installiert. AVE 
bietet Kompatibilität und Interoperabilität innerhalb 
der gesamten Produktlinie an Audio- und Video-
Editing-Lösungen von Avid sowie Unterstützung für 
zahlreiche Avid-HD- und -SD-MXF-Videoformate 
für Pro Tools-Videospuren ohne Transkodierung 
(einschließlich Avid DNxHD®). Mit der Avid Video 
Engine können Sie außerdem Monitoring für Avid-
HD- und -SD-MXF-Videoformate und QuickTime-
Medien über Avid Nitris® DX, Mojo® DX und 
andere von Avid qualifizierte Video-Interfaces 
anderer Hersteller durchführen.

MIDI
MIDI (Musical Instrument Digital Interface) 
ist ein Kommunikationsprotokoll für den 
Datenaustausch zwischen Musikinstrumenten. 
Dieser Industriestandard ermöglicht die 
Verbindung einer Vielzahl von Geräten 
unterschiedlicher Hersteller. Mit MIDI kompatibel 
sind etwa Synthesizer, Drum Machines, MIDI-
Patch-Bays, Effektgeräte, MIDI-Interfaces, MIDI-
Bedienoberflächen und MIDI-Sequenzer. 

MIDI-Geräte sind mit fünfpoligen DIN-Buchsen 
ausgestattet, die entweder mit IN, OUT oder 
THRU bezeichnet sind. Der MIDI OUT-Port 
übermittelt Nachrichten. Der MIDI IN-Port 
empfängt Nachrichten. MIDI THRU gibt aus, was 
am IN-Port empfangen wird. Die Verbindung 
einzelner MIDI-Geräte erfolgt mithilfe von MIDI-
Kabeln, die Sie in den meisten 
Musikfachgeschäften erwerben können. 

USB- und FireWire-kompatible MIDI-Geräte 
senden und empfangen MIDI-Nachrichten über 
USB oder FireWire an den und vom Computer.
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Das MIDI-Protokoll stellt 16 MIDI-Kanäle je Port 
zur Verfügung. Mit einem einzelnen MIDI-Kabel 
können über jeden der 16 Kanäle andere Daten 
übertragen werden. Diese 16 Kanäle können sich 
auf verschiedene MIDI-Geräte oder auf mehrere 
Kanäle in einem einzigen Gerät aufteilen (wenn 
dieses über eine sogenannte Multitimbral-
Funktion verfügt, d. h. mehrkanaligen Betrieb 
ermöglicht). Jeder Kanal kann einen anderen 
Instrumenten-Sound steuern. 

Pro Tools verfügt über hochleistungsfähige MIDI-
Sequencing-Fähigkeiten. Sie können MIDI-Daten 
auf Instrumenten- und MIDI-Spuren in Pro Tools 
aufnehmen, eingeben, bearbeiten und 
wiedergeben. Diese Aktionen können im Edit-
Fenster, im MIDI Editor-Fenster, im Score Editor-
Fenster und in der MIDI-Event-Liste 
vorgenommen werden. 

Zu den MIDI-Daten von Pro Tools zählen MIDI-
Notendaten (Notennummer, aktiviert/deaktiviert, 
Velocity-Wert) ebenso wie System Exclusive-
Daten (Sysex) und vieles mehr. MIDI-Daten 
können sowohl von externen MIDI-Geräten mit 
MIDI-Interface als auch mithilfe anderer MIDI-
Software (beispielsweise Instrumenten-Plug-Ins 
oder ReWire-Clientanwendungen) aufgenommen 
oder wiedergegeben werden.

Synchronization
Wenn Sie mit mehreren zeitbasierten Systemen 
arbeiten, etwa mit Pro Tools und einem externen 
Gerät, möchten Sie natürlich, dass die Systeme 
synchron arbeiten. Bei der Synchronisation gibt 
ein System die Taktquelle (den Timecode oder die 
MIDI Beat Clock) aus, der bzw. die dann von 
einem anderen Gerät befolgt wird, sodass die 
Geräte zusammen gemäß derselben Taktquelle 
arbeiten („synchron laufen“). Pro Tools kann mit 
einem SMPTE/EBU- oder MIDI-Timecode mit 
anderen Geräten (oder die Geräte mit Pro Tools) 
synchronisiert werden.

Surround-Sound
(Nur Pro Tools HD)

Surround-Sound bedeutet, dass ein oder mehrere 
Lautsprecher mit eigenen Audiosignalen (Kanälen) 
zusätzlich zu den üblichen Stereolautsprechern 
hinter dem Zuhörer platziert werden. 

Es gibt verschiedene Arten von Surround-
Formaten (von LCR mit drei Kanälen bis zum 
Format 7.1 mit acht Kanälen).

Das am häufigsten verwendete Surround-Format 
ist 5.1, also ein System mit fünf Lautsprechern und 
einem Subwoofer. Das 5.1-Format kommt in 
Kinos und Home Entertainment-Systemen zum 
Einsatz. Darüber hinaus sind die meisten DVDs 
für das Format abgemischt. Standardmäßig 
werden für 5.1-Surround-Sound linke und rechte 
Stereolautsprecher, ein zusätzlicher 
Frontlautsprecher, zwei weitere 
Stereolautsprecher hinten links und rechts und ein 
Subwoofer an der Seite verwendet. 

Pro Tools HD unterstützt das Mischen in 
Surround-Formaten. In Pro Tools wird jedes 
Surround-Format als Mehrkanalformat (Greater-
than-Stereo) angesehen.
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Pro Tools-Sessions
Wenn Sie ein Projekt mit Pro Tools beginnen, 
erstellen Sie zunächst eine Session.

Session-Dateien
Eine Session-Datei ist ein Dokument, das von 
Pro Tools angelegt wird, wenn Sie File > New 

Session wählen und eine neue Session 
konfigurieren. In Pro Tools kann nur eine Session 
gleichzeitig geöffnet sein. Dem Namen der 
Session-Datei wird automatisch die Erweiterung 
PTX (Pro Tools-Datei) angehängt. Die Session-
Datei enthält „Maps“, also Zuordnungen aller 
Elemente, die mit einem Projekt 
zusammenhängen, einschließlich der 
Audiodateien, der MIDI- und aller Edit- und 
Mixdaten. Dabei ist es jedoch wichtig, 
zu verstehen, dass die Pro Tools-Session-Datei 
selbst keine Mediendateien (Audio oder Video) 
enthält. Stattdessen verweist sie auf Audio-, 
Video-, MIDI- und andere Dateien. Sie können 
Änderungen an einer Session vornehmen und 
diese Änderungen in einer neuen Session-Datei 
speichern. Auf diese Weise ist es möglich, 
verschiedene Versionen einer Session zu erstellen 
und alle Überarbeitungen und Mixes zu sichern. 

Spuren
Auf den Pro Tools-Spuren werden Audio-, MIDI-, 
Video- und Automationsdaten aufgenommen und 
bearbeitet. Die Pro Tools-Spuren liefern auch die 
Audiokanäle für das Routing der internen Busse 
sowie die physischen Ein- und Ausgänge für 
Audio und MIDI.

Pro Tools verfügt über mehrere Arten von 
Spuren: Audio-, Auxiliary-Eingangs-, Master-
Fader-, VCA Master-, MIDI-, Instrumenten- 
und Videospuren.

Audio-, MIDI-, Instrumenten- und Videospuren 
können in Clips unterteilt oder an verschiedenen 
Positionen wiederholt werden. So können Loops 
erstellt, Abschnitte (Sections) oder ganze Songs 
neu arrangiert oder neue Spuren zusammengestellt 
werden, wobei Material aus mehreren Takes 
verwendet werden kann. 

Auxiliary-Eingangs-Spuren können interne 
Audio-Busse oder physikalische Eingänge auf 
interne Busse oder physikalische Ausgänge leiten. 
Auxiliary-Eingänge werden meist für Audio-
Effekt-Busse, Audiodurchsatz (Monitoring) und 
Submixing verwendet.

Master-Fader-Spuren bieten Steuermöglichkeiten 
für physikalische Audioausgangskanäle, 
einschließlich des Lautstärkepegels des Mix, 
Panoramaregelung (Panning) und Plug-In-Inserts.

Session-Datei-Symbol

Audiospur im Edit-Fenster (im Bild: Stereospur) 

MIDI-Spur im Edit-Fenster

Videospur in Framedarstellung
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VCA Master-Spuren (nur Pro Tools HD) 
ermöglichen die Steuerung von Spuren in einer Mix-
Gruppe, die dem VCA Master zugewiesen wurde.

Videospuren unterstützen QuickTime-Movies 
(alle Pro Tools-Systeme) und VC-1-Videodateien 
(nur Windows). Pro Tools unterstützt außerdem 
Avid-Video bei Verwendung der Avid Video 
Engine (AVE), entweder nativ oder mit einem 
unterstützten Avid-Videoperipheriegerät. Eine 
einzelne Videospur kann immer nur einen einzigen 
Videotyp gleichzeitig wiedergeben.

Audio-, Auxiliary-Eingangs-, Master-Fader- und 
Instrumentenspuren können vom Typ Mono, 
Stereo oder Mehrkanal (nur Pro Tools HD) sein. 
Wählen Sie beim Erstellen einer neuen Spur einen 
Eintrag aus der Liste der von Ihrem System 
unterstützten Kanalformate.

Voices
In Pro Tools sind Voices eindeutige, separate 
Audio-Streams, deren Routing von bzw. 
an physische Audioeingänge und -ausgänge und 
Pro Tools-Audiospuren auf den Pro Tools-Audio-
Interfaces erfolgen kann. Die Audiopfade zu bzw. 
von der Pro Tools-Software, die an die Pro Tools-
Hardware geroutet werden, verwenden Voices. 
Wenn Sie die Anzahl der verfügbaren Voices im 
System überschreiten, wird ebenfalls die 
verfügbare Anzahl der Audiopfade überschritten. 
Voices werden dynamisch zugeordnet. 

Normalerweise verwendet jeder Audiokanal für 
jede Spur in der Pro Tools-Session eine einzelne 
Voice. Für eine Mono-Audiospur wird eine 
einzelne Voice, für eine Stereo-Audiospur werden 
zwei Voices verwendet. Bei einer Punch-
Aufnahme sind zwei Voices für jeden Audiokanal 
erforderlich (eine für Wiedergabe und eine für 
Aufnahme bei Punch-In und Punch-Out). 

In einigen Fällen sind bei Pro Tools|HDX-
Systemen mehrere Voices für einen Kanal 
erforderlich (etwa Host-Verarbeitung auf einem 
DSP-Bus).

In Pro Tools|HDX-Systemen hängt die Anzahl der 
verfügbaren Voices von der Anzahl der 
zugewiesenen DSP-Ressourcen im System ab 
(siehe „Wiedergabe-, Aufnahme- und Voice-
Limits bei Pro Tools HD“ auf Seite 45).

In allen anderen Pro Tools-Systemen hängt die 
gesamte Anzahl der verfügbaren Voices im 
System von der Host-Verarbeitungsleistung des 
Computers ab (siehe „Pro Tools-
Systemfunktionen mit unterschiedlichen 
Hardware-Konfigurationen“ auf Seite 41).

Mediendateien
In Pro Tools-Sessions können Mediendateien 
erstellt, importiert, exportiert und als Referenz 
genutzt werden. Mediendateien können Audio-, 
MIDI- und Videodateien sein. Audio- und Video-
Mediendateien werden getrennt von der 
Pro Tools-Session-Datei gespeichert. MIDI-Daten 
werden in der Session-Datei gesichert.

Audiodateien

Jedes Mal, wenn Sie in einer Pro Tools-
Session Audiomaterial aufnehmen, werden 
Audiodateien erzeugt. 

Weitere Informationen zum Voicing in 
Pro Tools finden Sie unter „Priorität von 
Spuren und Voice-Zuweisung“ auf 
Seite 241.

Audiodatei-Symbol
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Die Audiodateien einer Session werden in einem 
Ordner mit der Bezeichnung „Audio Files“ 
gespeichert. Audiodateien werden in der 
Pro Tools-Clipliste aufgeführt und können in der 
Playlist einer Audiospur angezeigt werden. 
Einzelne Abschnitte einer Audiodatei können als 
Clips definiert werden. Siehe „Clips“ auf Seite 10.

MIDI-Dateien

Wenn Sie MIDI in einer Pro Tools-Session 
aufnehmen oder eingeben, werden alle MIDI-
Daten in der Session-Datei von Pro Tools 
gespeichert. Sie können MIDI-Dateien in oder aus 
Pro Tools-Sessions importieren bzw. exportieren, 
bei einer Aufnahme oder anderweitigen Erstellung 
von MIDI-Daten in einer Pro Tools-Session 
werden jedoch nicht automatisch neue MIDI-
Dateien erstellt.

Videodateien

Wenn Sie Video in einer Pro Tools-Session 
aufnehmen oder importieren, werden alle 
Videodaten unter dem entsprechenden 
Videodateityp (etwa QuickTime) gespeichert. 
Videodateien können im Ordner für Videodateien 
oder im Session-Ordner erstellt (oder in ihn 
kopiert) werden. In den meisten Fällen verweist 
Pro Tools allerdings auf Videodateien, die von 
einer anderen Anwendung, etwa Avid Media 
Composer®, aufgenommen wurden.

Clips
Ein Clip ist ein Segment von Audio-, MIDI- oder 
Videodaten. Ein Clip kann aus einem Drum-Loop, 
einem Gitarrenriff, einer Strophe, einem Take, 
einem Soundeffekt, einem Dialog oder auch aus 

einer ganzen Sound-Datei bestehen. Clips sind 
besonders für das Anordnen von Audio und MIDI 
nützlich. Ein Clip kann mit Automationsdaten 
verknüpft sein. Clips werden in Pro Tools aus 
Audiodateien oder MIDI-Daten erzeugt und 
können in den Playlists von Audio- und MIDI-
Spuren angeordnet werden. Clips können auch 
gruppiert sein (ein aus Clips bestehender Clip) und 
in Loops (Wiederholungen) abgespielt werden.

MIDI-Datei-Symbol

Audioclip

MIDI-Clip

Videoclip (Framedarstellung)

Clipgruppe (gemischte Audio- und MIDI-Multitrack-
Clipgruppe)
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Playlists
Als Playlist bezeichnet man eine Abfolge von 
Clips, die auf einer Audio-, MIDI- oder Videospur 
angeordnet sind. Spuren verfügen über Edit-
Playlists und Automation-Playlists. 

Bei Audiospuren wird über die Edit-Playlist 
festgelegt, welche Audioclips in welcher 
Reihenfolge von der Festplatte wiedergegeben 
werden sollen. Ein Song kann beispielsweise aus 
mehreren separaten Audioclips für das Intro, 
die erste Strophe, den ersten Refrain usw. 
bestehen. Mithilfe von Audioclips können Sie 
mehrmals an verschiedenen Stellen auf dieselbe 
Audiodatei zugreifen, ohne dabei zusätzlichen 
Festplattenspeicher zu belegen. Es können 
außerdem verschiedene Versionen desselben 
Original-Audiomaterials an verschiedenen Stellen 
verwendet und dabei verschiedene Effekte 
angewendet werden. Auf MIDI- und 
Instrumentenspuren können Edit-Playlists 
mehrere MIDI-Sequencen (oder Performances) 
auf einer Spur speichern. 

Eine Playlist kann entweder aus einem einzigen 
Clip oder auch aus vielen einzelnen Clips 
bestehen. Sie kann aus einer Reihe ähnlicher 
Elemente zusammengesetzt sein (wie etwa 
Clips, die aus mehreren verschiedenen Takes 
eines Solos bestehen) oder auch aus 
unterschiedlichen Elementen (wie etwa 
verschiedenen Soundeffekten). 

Sie können für eine Spur eine beliebige Anzahl 
von alternativen Edit-Playlists erstellen. Auf diese 
Weise können Sie mehrere Versionen einer 
Performance oder eines Bearbeitungsvorgangs auf 
einer einzigen Spur zusammenstellen und mithilfe 
des Playlists-Menüs zwischen ihnen wählen.

Jede Audio-, Auxiliary-Eingangs-, Instrumenten-, 
Master-Fader- und VCA-Spur verfügt außerdem 
über einen einzelnen Satz von Automation-
Playlists. Dazu gehören Lautstärke, Panorama, 
Stummschalten und alle automatisierten 
Steuerelemente für die Insert- und Send-
Zuweisungen auf dieser Spur. 

MIDI-Controller-Daten auf Instrumenten- und 
MIDI-Spuren sind immer als Teil der Spuren-
Playlist inbegriffen.

Kanäle
Der Begriff Kanal (Channel) steht in Pro Tools-
Systemen für mehrere miteinander verwandte 
Komponenten. 

Zum einen ist damit der physische Ein- oder 
Ausgang Ihres Pro Tools-Systems gemeint. 
Beispielsweise stellt ein HD I/O-Interface bis zu 
16 Kanäle als Audioeingänge und -ausgänge für 
ein Pro Tools|HDX- oder Pro Tools|HD Native-
System zur Verfügung, während das Mbox Pro-
Audio-Interface bis zu 8 Ein- und Ausgänge 
bereitstellt.

Zweitens bezeichnet der Begriff Kanal einen 
Kanalzug im Pro Tools Mix-Fenster. Jede Spur in 
einer Pro Tools-Session besitzt einen 
entsprechenden Kanalzug im Mix-Fenster.

Playlist-Selektor-Popup-Menü



Pro Tools-Referenzhandbuch12

Audio- und MIDI-Kanalzüge sind mit den 
gleichen Steuerelementen ausgestattet, doch haben 
diese unterschiedliche Auswirkungen. So steuern 
etwa die Fader der Kanalzüge von Audio-, 
Auxiliary-Eingangs- und Instrumentenspuren die 
Ausgangsverstärkung für den Mix-Bus dieses 
Kanals direkt, während die Fader von MIDI-
Kanalzügen MIDI-Volume-Daten (MIDI-
Controller 7) an das ausgewählte MIDI-
Instrument senden. 

Der Begriff „MIDI-Kanal“ wird außerdem 
im Zusammenhang mit der Übermittlung von 
MIDI-Daten verwendet. Siehe „MIDI“ auf 
Seite 6.

Kanalzug im Mix-Fenster (Audiospur)
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Signal-Routing
Pro Tools stellt softwarebasierte Steuerelemente 
zum Mischen und Signal-Routing für Audio- und 
MIDI-Daten zur Verfügung. Diese Steuerelemente 
finden sich im Mix-Fenster. Auf einige dieser 
Steuerelemente kann auch vom Edit-Fenster aus 
zugegriffen werden.

Das Routen von Audiosignalen wird häufig 
gebraucht, um zum Zweck der gemeinsamen 
Bearbeitung und Pegelsteuerung von mehreren 
Spuren einen Submix auf einem Kanalzug (etwa 
einem Auxiliary-Eingang) zu erstellen. Das 
folgende Beispiel zeigt einen Submix von zwei 
Audiospuren auf einen Stereo-Auxiliary-Eingang.

Submix auf einen Auxiliary-Eingang

Input von
Stereo-
Buspfad

Output an
Stereo-
Buspfad

Inserts

Sends

Audiospuren Auxiliary-
Eingangs-Spur
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Optionen für Signal-Routing

Für das Signal-Routing stehen folgende Optionen 
zur Verfügung: 

Steuerelemente für den Spurenein- und 
-ausgang das Leiten von Signalen über Eingänge 
und Ausgänge von Spuren ist die Grundform des 
Signal-Routing. Jeder Spur muss ein Eingangspfad 
zugewiesen sein, damit Audiodaten aufgenommen 
werden können, und ein Ausgangspfad, damit das 
aufgenommene Audio über einen Hardware-
Ausgang hörbar gemacht werden kann. Unter 
Verwendung von internen Bussen können Signale 
auch von und auf andere Spuren in Pro Tools 
(bzw von und auf Hardware-Eingänge und -
Ausgänge) geroutet werden.

Auxiliary-Eingangs- und Master-Fader-Spuren – 
Auxiliary-Eingänge können als Returns, Submixer 
und Bus-Master verwendet werden. Master-Fader-
Spuren werden als Master-Pegelregler für Busse 
und Ausgänge verwendet. Sowohl Auxiliary-
Eingangs- als auch Master-Fader-Spuren können 
mit Plug-In- und Hardware-Inserts ausgestattet sein.

MIDI-Spuren – MIDI-Spuren werden im 
Allgemeinen zum Routen von MIDI-Daten von 
internen oder externen Quellen auf externe MIDI-
Geräte verwendet. MIDI-Daten können auch auf 
Plug-Ins auf Auxiliary-Eingangs- oder 
Instrumentenspuren geroutet werden.

Instrumentenspuren – Instrumentenspuren 
stellen die wichtigste Möglichkeit zum Routen von 
MIDI-Daten auf ein Instrumenten-Plug-In 
und zum weiteren Routen der Plug-In-Sounds 
auf Ausgänge, Sends, Busse oder Inserts dar. 
Instrumentenspuren können auch verwendet werden, 
um MIDI-Daten an externe MIDI-Geräte zu senden 
und Audioinhalte über diese Geräte abzuhören.

Sends – Sends routen Audiosignale von Spuren 
auf Hardware-Ausgänge oder auf interne Busse, 
die dann wiederum auf andere Spuren in Pro Tools 
weitergeleitet werden. MIDI-, Master-Fader- und 
VCA Master-Spuren verfügen nicht über Sends.

Plug-Ins und Hardware-Inserts – die 
Verarbeitung mit Plug-Ins geschieht vollständig 
innerhalb von Pro Tools. Hardware-Inserts 
verwenden Eingänge und Ausgänge des Audio-
Interface zum herkömmlichen Routen von Inserts 
auf externe Effektgeräte und andere Geräte 
(in beiden Richtungen). MIDI- und VCA Master-
Spuren verfügen nicht über Inserts.

Instrument-Plug-Ins – Instrumenten-Plug-Ins 
unterscheiden sich von Verarbeitungs-Plug-Ins 
insofern, als sie Audioinhalte eher erzeugen, 
als dass sie das Audiosignal vom Audioeingang 
einer Spur oder von der Festplatte verarbeiten. 
Instrumenten-Plug-Ins werden üblicherweise über 
MIDI gesteuert.

Pfade – als Pfade bezeichnet man alle Routing-
Optionen in Pro Tools, einschließlich interner oder 
externer Eingänge, Ausgänge, Busse und Inserts. 
Sie können diese Pfade mit Namen versehen, 
die dann in den Audio-Input Path- und -Output 
Path-Selektoren und in anderen Menüs angezeigt 
werden. Weitere Informationen finden Sie unter 
Kapitel 7: „I/O-Setup“.

Mischformate – Sessions können aus einer 
Kombination von Spuren im Mono-, Stereo- und 
Mehrkanalformat (Greater-than-Stereo) sowie 
Bussen, Eingängen, Ausgängen und Inserts 
bestehen. Mehrkanalformate werden nur unter 
Pro Tools HD unterstützt.

Gruppieren und VCA-Spuren – Spuren können 
zum Mischen so gruppiert werden, dass das 
Verhältnis ihrer Mix-Einstellungen auch bei 
Änderung einer einzelnen Einstellung beibehalten 
wird. So wirkt sich beispielsweise die Änderung 
der Lautstärke in einer Spur auf alle anderen 
Spuren in der Gruppe aus. VCA Master-Spuren 
(nur Pro Tools HD) steuern die relativen Mix-
Einstellungen für alle Spuren innerhalb der 
ausgewählten Gruppe.
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Tick- und samplebasierte 
Zeit
Mit Pro Tools können Sie die Spur-Zeitbasis 
sample- oder tickbasiert festlegen. Sie können 
auch auswählen, dass die Timeline als tick- oder 
samplebasiert angezeigt wird.

Audiomaterial basiert in Pro Tools standardmäßig 
auf Samples. Ein Audioclip, der sich an einer 
bestimmten Sample-Position befindet, bleibt auch 
dann an dieser Stelle, wenn sich innerhalb der 
Session das Tempo ändert. Allerdings ändert sich 
ihre Taktposition.

MIDI-Daten basieren in Pro Tools standardmäßig 
auf Ticks. Ein MIDI-Clip, der sich an einer 
bestimmten Taktposition befindet, bleibt auch 
dann an dieser Stelle, wenn sich innerhalb der 
Session das Tempo ändert. Allerdings ändert sich 
ihre Sample-Position.

Sie können entweder bereits bei der Spurenerstellung 
bestimmen, ob eine Spur sample- oder tickbasiert 
sein soll, oder die Zeitbasis später ändern. 

Samplebasiertes Audio- und 
MIDI-Material
Mit einer samplebasierten Audiospur haben 
alle Clips in der Spur eine absolute Position 
in der Timeline. Auch bei Tempo- und 
Taktartänderungen in einer Session bleiben die 
Clips an die Samplezeit gebunden.

Wenn Sie eine MIDI-Spur samplebasiert 
erzeugen, haben alle MIDI-Events in der Spur eine 
absolute Position in der Timeline. Auch bei 
Tempo- und Taktartänderungen in einer 
Session bleiben die MIDI-Events an die Sample-
Zeit gebunden.

Tickbasiertes Audio- und MIDI-
Material
Tickbasiertes Audiomaterial orientiert sich an 
Taktpositionen und bewegt sich bei Tempo- und 
Taktartänderungen relativ zur Sample-Timeline. 
Hinsichtlich der Länge reagieren MIDI-Events 
und tickbasiertes Audiomaterial allerdings 
unterschiedlich auf Tempoänderungen. Während 
sich die Länge von MIDI-Noten-Events beim 
Anpassen von Taktart oder Tempo verändert, 
ist dies bei Audioclips nicht der Fall (außer wenn 
die Elastic Audio-Option aktiviert ist). Wenn die 
Elastic Audio-Option für eine Audiospur 
nicht aktiviert ist, wirkt sich eine Tempo- oder 
Taktartänderung nur auf den Startpunkt 
(oder Sync-Punkt) jedes Audioclips in einer 
tickbasierten Spur aus. Ist die Elastic Audio-
Option für eine Audiospur aktiviert, wird 
bei Tempoänderungen die Elastic Audio-
Verarbeitung angewandt, wodurch die Länge des 
Audioclips geändert wird.
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Elastic Audio
Elastic Audio bietet Echtzeit- und Nicht-Echtzeit- 
(gerenderte) Audio-TCE (Time Compression and 
Expansion). Tickbasierte Elastic Audio-Spuren 
ändern die Position von Samples entsprechend 
den vorgenommenen Tempoänderungen. 
Das Audiomaterial wird entsprechend den 
Tempoänderungen komprimiert oder ausgedehnt. 
Die Elastic Audio-Option ermöglicht auch 
clipbasiertes Pitchshifting (nicht in Echtzeit) in 
hoher Qualität.

Pro Tools Elastic Audio verwendet außergewöhnlich 
hochwertige Algorithmen zur Feststellung 
von Signalspitzen, eine Takt- und Tempoanalyse 
und TCE-Verarbeitungsalgorithmen (Echtzeit 
oder gerendert). Mit Elastic Audio können Sie 
Audiomaterial schnell und einfach tempo- und 
taktkonform an die Tempo-Leiste der Session 
anpassen. Elastic Audio bietet auch eine beispiellose 
Kontrolle über die Feststellung von Signalspitzen 
und die TCE-Bearbeitung für jedes einzelne Event.

Mit Elastic Audio analysiert Pro Tools komplette 
Audiodateien im Hinblick auf Signalspitzen. Ein 
Event kann beispielsweise ein Trommelschlag, 
eine erklingende Note oder ein mit einer Gitarre 
gespielter Akkord sein. Die ermittelten 
Signalspitzen können dann als Kontrollpunkte für 
das Audio-Warping genutzt werden. Pro Tools 
kann Audio-Events automatisch warpen (TCE), 
etwa beim automatischen Angleichen von 
Audiomaterial an das Session-Tempo oder beim 
Quantisieren von Audio-Events. Darüber hinaus 
können Sie Audiomaterial manuell warpen 
mithilfe der standardmäßigen Bearbeitungs-Tools 
(mit der Audiospur in der Warp-Darstellung).

Elastic Audio ist bei den folgenden häufig 
verwendeten Arbeitsabläufen hilfreich: Arbeiten 
mit Loops, Korrigieren von Performances, 
Remixen, Angleichen von Takt und Tonhöhe, 
Sounddesign oder Spezialeffekte. 

Systemressourcen
Die Anzahl der Spuren, die Verarbeitung durch 
Plug-Ins, Signalpfad- und Routing-Optionen 
sowie die Verfügbarkeit von Voices hängen nicht 
zuletzt von den Gesamtressourcen des Host-
Computers und Ihrer Pro Tools-Hardware ab. 

Pro Tools hilft auf verschiedene Weise, Ressourcen 
zu verwalten und einzusparen und damit die 
Leistungsfähigkeit Ihres Systems zu erhöhen. 
Zu Beginn Ihrer Arbeit mit Sessions und Spuren 
in Pro Tools können Sie folgende Funktionen 
nutzen, um die Effizienz Ihrer vorhandenen DSP- 
und anderer Ressourcen zu steigern:

 Mit Pro Tools können Sie die Leistung Ihres 
Systems anpassen, indem Sie die 
Systemeinstellungen ändern, die sich auf die 
Verarbeitungs-, Wiedergabe- und 
Aufnahmekapazität auswirken. Siehe 
„Konfigurieren der Pro Tools-
Systemeinstellungen“ auf Seite 52.

 In Pro Tools können Sie bestimmte Elemente 
(wie beispielsweise Spuren und Inserts) manuell 
deaktivieren, um wertvolle DSP-Ressourcen 
freizusetzen. Inaktive Elemente können angezeigt 
und bearbeitet werden und bleiben in der Session 
erhalten. Siehe „Aktive und inaktive Elemente“ 
auf Seite 17.

 Alle Pro Tools-Systeme bieten flexible Voice-
Optionen für Audiospuren, damit die im System 
verfügbaren Voices optimal genutzt werden 
können. Weitere Informationen zur Verwaltung 
von Voices und den dazugehörigen Optionen 
finden Sie unter „Priorität von Spuren und Voice-
Zuweisung“ auf Seite 241. 
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Aktive und inaktive Elemente
In Pro Tools können Sie bestimmte Elemente 
(beispielsweise Spuren und Inserts) auf inaktiv 
festlegen, um DSP-Ressourcen und Mischpult-
Verbindungen freizugeben. 

Folgende Elemente in Pro Tools können 
beispielsweise deaktiviert werden:

• Audio-, Auxiliary-Eingangs-, Master-Fader-, 
VCA Master- und Instrumentenspuren

• Ein- und Ausgänge von Spuren

• Sends

• Sidechain-Eingänge

• Plug-Ins

• Hardware-Inserts

• Pfade (Session-übergreifend)

Abgesehen von der Möglichkeit der manuellen 
Aktivierung bzw. Deaktivierung von Elementen 
deaktiviert Pro Tools bestimmte Elemente 
automatisch, wenn diese nicht zur Verfügung 
stehen oder nicht genügend Ressourcen vorhanden 
sind. 

Aktive Elemente sind in vollem Umfang 
betriebsbereit.

Inaktive Elemente sind stumm und „aus“, obwohl 
die meisten damit verknüpften Steuerelemente 
weiterhin bearbeitet werden können. Inaktive 
Elemente wirken sich unterschiedlich auf 
vorhandene Systemressourcen aus:

Plug-Ins – wenn ein Plug-In auf einer Spur inaktiv 
ist, werden die dazugehörigen DSP-Ressourcen 
für andere Plug-Ins und zur Bearbeitung zur 
Verfügung gestellt. Plug-In-Zuweisungen können 
entweder manuell oder automatisch deaktiviert 
werden. 

Pfade und Pfadzuweisungen – ist ein Pfad oder 
eine Pfadzuweisung inaktiv geschaltet, werden die 
zugehörigen Mischpult-Ressourcen für andere 
Zwecke des Signal-Routing innerhalb der Session 
zur Verfügung gestellt. Pfade und Zuweisungen 
können entweder manuell oder automatisch 
deaktiviert werden.

Spuren – wenn Sie eine Spur deaktivieren, werden 
deren Voices für eine andere verfügbar. Inaktive 
Monospuren stellen eine Voice zur Verfügung und 
inaktive Stereo- und Mehrkanalspuren eine Voice 
pro Kanal. Außerdem werden bei der 
Deaktivierung von Audio-, Auxiliary-Eingangs- 
oder Master-Fader-Spuren auch die dazugehörigen 
Plug-Ins, Inserts, Sends und I/O-Zuweisungen 
deaktiviert. Die entsprechenden DSP-Ressourcen 
können dann an anderen Stellen der Session 
genutzt werden.

MIDI-Spuren können nicht deaktiviert werden. 

Sidechain-Eingänge können zwar direkt 
aktiviert bzw. deaktiviert werden, eine 
Aktivierung/Deaktivierung aller bzw. aller 
ausgewählten Sidechain-Eingänge wird 
jedoch nicht unterstützt.
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Anzeige von inaktiven Elementen

Die Namen von inaktiven Elementen erscheinen 
kursiv und sind dunkelgrau hinterlegt. 
Bei inaktiven Spuren erscheint der gesamte 
Kanalzug ausgegraut.

Workspace-Browser
Bei Workspaces handelt es sich um ein 
Datenbankverwaltungs-Tool für Pro Tools. 
Workspace-Browser sind eine Erweiterung der 
Pro Tools-Funktionen zum Suchen und 
Importieren. Das Programm ermöglicht die 
Verwaltung von Daten innerhalb und außerhalb 
von Sessions auf jeder mit dem System 
verbundenen Festplatte.

Eine Datenbank ermöglicht es, Daten so 
anzuordnen, dass sie auf einfache Weise 
durchsucht, sortiert, verwaltet und genutzt werden 
können. Ihr Scheckbuch ist ein einfaches Beispiel 
dafür, wie eine Datenbankdatei organisiert ist. 
Für jeden Scheck, den Sie ausstellen, legen 
Sie einen neuen Datensatz an. Dieser 
enthält Informationen zum Scheck: das 
Ausstellungsdatum, den Begünstigten und den 
Betrag. Die Informationen werden in bestimmte 
Spalten (Felder) eingegeben. Das Scheckbuch 
enthält alle notwendigen Informationen (die 
Metadaten des Schecks), jedoch nicht den 
ausgestellten Scheck selbst.

Mit Workspace-Browsern können Sie diese 
Datenbanken nach Laufwerk oder Katalog 
durchsuchen, sortieren und verwalten. Sie 
können Workspace-Browser nicht nur zum 
Organisieren Ihrer Pro Tools-Sessions und 
Mediendateien (Audio, MIDI und Video) 
verwenden, sondern auch zum Abhören und 
Importieren per Drag & Drop.

Aktive und inaktive Plug-Ins, Sends und Spuren

Aktives Plug-In Inaktives Plug-In 

Inaktive Spur 

Weitere Informationen finden Sie unter 
Kapitel 16: „Workspace-Browser“.
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AAF, MXF und OMF
In Pro Tools können Sie Audio, Video und 
Sequenzen mit anderen AAF-, MXF- und OMF-
kompatiblen Anwendungen (wie Avid-Editoren) 
austauschen.

Mediendaten (Mediendateien)
Mediendaten stellen unbearbeitetes Audio- und 
Videomaterial dar und werden in einzelnen 
Mediendateien gespeichert. Bei jeder Aufnahme 
von Video- oder Audiomaterial in eine 
Anwendung wird eine Mediendatei erzeugt. 
Audio-Mediendateien enthalten Samples (etwa 
44.100 oder 48.000 Samples pro aufgenommene 
Sekunde), während Video-Mediendateien Frames 
(24, 25 oder 30 Frames pro aufgenommene 
Sekunde) verwenden.

Die Größe einer Mediendatei hängt davon ab, 
wie viel Audio- oder Videomaterial sie enthält. 
Beispielsweise entspricht eine Datei, die zehn 
Minuten Video mit hoher Auflösung enthält, einer 
Größe von etwa 2 GB, eine zehnminütige 
Audioaufnahme hingegen entspricht einer 
Dateigröße von etwa 100 MB. Mediendateien 
können leicht sehr groß werden, da Audio- und 
Videosignale mit hoher Qualität sehr datenintensiv 
sind. Videodaten benötigen im Allgemeinen 
bedeutend mehr Speicherplatz als Audiodaten.

Metadaten
Der Begriff Metadaten bezeichnet Folgendes:

• Informationen zu einer Mediendatei; dazu 
können Szene, Take, Samplerate, Bittiefe, 
Namen externer Clips, der Name des 
Videobands, von dem die Mediendatei erfasst 
wurde, und sogar Timecode-Werte zählen.

• In Pro Tools-Sessions oder anderen Sequenzen 
eingebettete Informationen, auch darüber, 
welche Dateien verwendet werden, wo sie in der 
Timeline erscheinen und über Automation.

• (für AAF- oder OMF-Sequenzen) 
Informationen über nicht gerenderte 
AudioSuite™-Effekte (wie etwa Echtzeit-EQ) 
auf Avid-Workstations. Pro Tools importiert 
keine nicht gerenderten Effekte. Gerenderte 
Effekte sind Mediendateien, die in Pro Tools 
importiert werden können.

• (für AAF- oder OMF-Sequenzen) 
Informationen zur Automation (Clip-Gain oder 
Keyframe-Gain).

Grundlegendes zu AAF, OMF und 
MXF
Bei AAF- und OMF-Dateien handelt es sich um 
Mechanismen für das Speichern und 
Wiederauffinden von Mediendaten und 
Metadaten, mit denen Projekte frei zwischen 
verschiedenen Anwendungen und Plattformen 
ausgetauscht werden können. MXF ist ein 
Mediendateiformat, das mit AAF-(nicht aber 
OMF-)Dateien verwendet werden kann.

Mit Medien- und Metadaten kann in einer 
Anwendung, die AAF- und OMF-Sequenzdateien 
empfängt (beispielsweise Pro Tools) eine 
Komposition automatisch und schnell 
wiederhergestellt werden. Diesen Ansatz kann 
man verbildlichen, indem man sich die 
Mediendateien als Stücke eines Puzzles und die 
Metadaten als Anweisungen für das 
Zusammensetzen des Puzzles vorstellt.



Pro Tools-Referenzhandbuch20

Im einfachsten Fall wird nur eine AAF- oder 
OMF-Sequenz ausgetauscht. Wenn diese Sequenz 
auf vorhandene Mediendaten verweist, ist die 
Sequenzdatei relativ klein und der Export- oder 
Importvorgang relativ schnell. 

AAF- und OMF-Sequenzen können auch 
eingebettete Mediendaten enthalten. Dadurch 
entsteht eine einzelne, größere Datei, deren Export 
und Import länger dauert, die aber einfacher zu 
verwalten ist als Tausende auf verschiedenen 
Volumes gespeicherte kleinere Dateien.

AAF

AAF ist ein Sequenzdateiformat. AAF-Sequenzen 
eignen sich optimal zum Austauschen von 
Projekten und Verwalten wertvoller Metadaten. 
Eine AAF-Sequenz kann auf OMF-Mediendateien 
verweisen oder eingebettete OMF-Mediendateien 
enthalten. Es gibt keine Audio- oder 
Videomediendateien im AAF-Format.

Pro Tools unterstützt Import, Wiedergabe und 
Export von AAF-Sequenzen, die entweder mit 
Mediendateien verknüpft sind oder eingebettetes 
Audiomaterial enthalten.

Wenn Sie eine AAF-Sequenz mit eingebettetem 
Audiomaterial in Pro Tools importieren, wird das 
Audiomaterial mit dem Audiodateiformat der 
aktuellen Session in Monospuren extrahiert.

MXF

MXF ist ein Mediendateiformat. Es gibt MXF-
Videodateien und MXF-Audiodateien, aber keine 
MXF-Sequenzen. AAF-Sequenzen können auf 
MXF-Mediendateien verweisen oder diese 
Dateien enthalten, OMF-Sequenzen jedoch nicht.

Pro Tools kann MXF-Audiodateien und 
-Videodateien importieren und 
wiedergeben, die in Media Composer 
oder anderen Avid-Anwendungen 
erstellt wurden.

OMF

OMF ist sowohl ein Mediendateiformat als auch 
ein Sequenzformat. OMF-Mediendateien können 
als Audio- oder Videomaterial vorliegen. 
Pro Tools unterstützt den Import und die 
Wiedergabe von OMF-Audio, aber nicht von 
OMF-Video. Pro Tools unterstützt auch den 
Export von OMF-Audio, nicht jedoch von OMF-
Video.

In Pro Tools können OMF-Audiodateien, die in 
Media Composer oder anderen Anwendungen 
erstellt wurden, importiert und wiedergegeben 
werden.

OMF-Sequenzen können weder Verweise auf 
noch Einbettungen von MXF-Mediendateien 
enthalten.

Pro Tools unterstützt den Import von OMF-
Sequenzen mit eingebettetem Audio, nicht jedoch 
mit eingebettetem Video.

MXF-Dateisymbol



Kapitel 2: Pro Tools-Konzepte 21

Pro Tools- und Media 
Composer-Terminologie
Pro Tools und Avid Media Composer® verwenden 
unterschiedliche Termini für die Beschreibung für 
dieselben Elemente. Beispielsweise entspricht 
eine Session in Pro Tools einer Avid-Sequenz. 
In der folgenden Tabelle werden gebräuchliche 
Pro Tools-Elemente und ihre Entsprechungen bei 
Avid aufgeführt.

Pro Tools Avid (AAF oder OMF)

Session Sequenz

Whole-File-Clip Master-Clip

Clip Subclip

Plug-Ins Echtzeit-Audioeffekte

Lautstärkeautomations-
Gain

Avid-Keyframe-
Lautstärke

In der Clipliste werden vollständige 
Audiodateien normalerweise fett dargestellt. 
Aus AAF oder OMF in Pro Tools importierte 
Audiodateien eines Master-Clips werden 
jedoch in der Clipliste von Pro Tools nicht 
fett dargestellt (Hinweis auf Clips), obwohl es 
sich um Audiodateien handelt.
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Eingebettete und verknüpfte Medien
Es gibt zwei Arten von AAF- und OMF-Dateien: mit eingebetteten Medien und mit verknüpften Medien. 

Eingebettete Medien
Beim Exportieren in AAF oder OMF mit eingebetteten Medien entsteht eine große AAF- oder OMF-Datei, 
die sowohl die Metadaten als auch alle verknüpften Mediendateien enthält.

Austausch-Workflow für AAF/OMF mit eingebetteten Medien

Auf Avid-Workstation bearbeitete Sequenz
Ursprüngliche Quell-Mediendateien

Eingebettete AAF/OMF-Datei (Metadaten und Medien)

Exportieren von AAF/OMF mit 
eingebetteten Medien erstellt ...

Konsolidierte Mediendateien 
(mit Handles)

Sequenz (Metadaten)

Verweist 
auf:
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Verknüpfte Medien
Beim Exportieren von AAF oder OMF mit verknüpften Dateiverweisen entsteht eine einzige 
Metadatendatei (AAF oder OMF) und alle verknüpften Medien werden in getrennten Dateien gespeichert.

Der Hauptvorteil dieses Ansatzes liegt darin, dass weniger Kopien von Mediendateien gemacht werden 
müssen und der Export- und Importvorgang auf diese Weise viel schneller ist. Mit diesem Ansatz ist es 
weniger wahrscheinlich, dass Sie auf Begrenzungen in der Dateigröße stoßen, da die Daten in viele 
kleinere Dateien aufgeteilt werden.

Der Hauptnachteil dieses Ansatzes besteht darin, dass potenziell viele Dateien (etwa eine AAF- 
oder OMF-Datei und hunderte von Mediendateien) von einem System auf das andere übertragen 
werden müssen.

Austausch vonAAF undOMF mit verknüpften Medien

Auf Avid-Workstation bearbeitete Sequenz

Ursprüngliche Quell-Mediendateien

Avid Workstation exportiert 
editierte Sequenzen und 
Dateiinformationen als 

AAF- oder OMF-Sequenzen

AAF/OMF-Datei (nur Metadaten)

Pro Tools importiert 
Session-Datei

Umgewandelte Pro Tools-Session-Datei

Verk
nü

pft
 m

it:

Verknüpft m
it:

Verknüpft mit:
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Kapitel 3: Tasten- und Mauskombinationen

In Pro Tools® gibt es viele Tasten- und 
Rechtsklick-Kombinationen, die Ihnen ein 
schnelles und einfaches Arbeiten ermöglichen.

Eine vollständige Liste der Tastenbefehle für 
Pro Tools finden Sie in der Online-Hilfe und in 
einem PDF-Handbuch.

So finden Sie die vollständige Liste der 
Tastenbefehle für Pro Tools in der Online-Hilfe:

1 Wählen Sie „Help > Pro Tools Help“.

2 Klicken Sie auf der Seite „Content“ (links von 
„Help“) auf „Pro Tools Shortcuts“.

So finden Sie die vollständige Liste der 
Tastenbefehle für Pro Tools im Pro Tools-
Handbuch für Tastenkombinationen.

 Wählen Sie „Help > Shortcuts“.

Mauskombinationen
Rechtsklickkombinationen

Pro Tools bietet Rechtsklick-Kombinationen 
zur Auswahl verschiedener Pro Tools-Befehle 
und -Menüs mit jeder rechtsklickfähigen Maus. 

Mausrad-Funktionen

In Pro Tools können Sie die Werte numerischer 
Felder durch Markieren des Werts und Scrollen 
mit dem Mausrad nach oben bzw. unten erhöhen 
bzw. verringern. 

Eine vollständige Liste der Rechtsklick-
Kombinationen finden Sie im Pro Tools-
Handbuch für Tastenkombinationen.
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Globale Tastaturbefehle
Einige Tastenkombination können auf 
verschiedene Funktionen in Pro Tools angewendet 
werden.

Spurfunktionen

Pro Tools bietet Tastenkombinationen für die 
folgenden Spurfunktionen:

• Ändern des Automationsmodus

• Aktivieren von Playlists

• Hinzufügen von Plug-Ins

• Scharfschalten, Soloschalten und 
Stummschalten von Spuren

• Aktivieren des Record Safe- und Solo Safe-
Modus für Spuren

• Zuweisen von Eingängen, Ausgängen und 
Sends

• Umschalten zwischen der Anzeige von 
Lautstärke, Spitzenwerten und Verzögerung

• Zurücksetzen der Pegelanzeigen

• Ändern der Darstellungshöhe von Spuren

Auswahl von Listen und Parametern

Pro Tools bietet Tastenkombinationen für die 
folgenden Elemente:

• Auswählen von Spuren in der Tracks-Liste

• Aktivieren von Gruppen in der Groups-Liste

• Aktivieren von Parametern im Automation 
Enable-Fenster

• Einstellen der Parameter für Memory Locations

Steuerelemente und Editing-Tools

Pro Tools bietet Tastenkombinationen zum 
Verschieben von Plug-In-Steuerelementen, Fadern 
und Schiebereglern, Automationsdaten sowie des 
Scrubbers.

Eine vollständige Liste von 
Tastenkombinationen finden Sie im Shortcuts 
Guide.

Command Windows Mac

Anwenden der 
Aktion auf alle 
Kanalzüge/Spuren

Alt + Aktion Wahl + 
Aktion

Anwenden der Aktion 
auf selektierte 
Kanalzüge/Spuren

Alt + 
Umschalt + 
Aktion

Wahl + 
Umschalt + 
Aktion

Command Windows Mac

Element umschalten 
und alle anderen auf 
denselben Status 
setzen

Alt + Klicken 
auf Element

Wahl + 
Klicken auf 
Element

Element umschalten 
und alle anderen auf 
den umgekehrten 
Status setzen

Strg + 
Klicken auf 
Element

Befehl + 
Klicken auf 
Element

Command Windows Mac

Feineinstellung von 
Schiebereglern, 
Drehreglern und 
Breakpoints

Strg + 
Klicken auf 
Element

Befehl + 
Klicken auf 
Element
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Tastaturfokus
Der Tastaturfokus in Pro Tools bestimmt die 
Funktion der Buchstabentasten auf der 
alphanumerischen Tastatur. Je nachdem, welcher 
Tastaturfokus aktiviert ist, können Sie über die 
alphanumerische Tastatur Clips in der Clipliste 
auswählen, Gruppen aktivieren bzw. deaktivieren 
oder einen Edit- oder Wiedergabebefehl 
ausführen.

Es kann immer nur einer der drei Tastaturfokus-
Modi aktiviert sein. Durch Aktivieren eines 
Tastaturfokus wird der vorherige deaktiviert.

Es gibt drei Tastaturfokus-Modi:

Befehls-Tastaturfokus – wenn diese Option im 
Fensterbereich „Tracks“ des Edit-Fensters oder im 
Notes-Fensterbereich eines beliebigen MIDI 
Editor-Fensters ausgewählt ist, steht eine große 
Anzahl einzelner Tastenkombinationen zur 
Bearbeitung und Wiedergabe zur Verfügung. 
Bei aktiviertem Befehls-Tastaturfokus wird immer 
das vorderste Edit- oder MIDI Editor-Fenster über 
Tastenkombinationen angesteuert.

Auch wenn der Befehls-Tastaturfokus deaktiviert 
ist, können Sie alle entsprechenden 
Tastaturbefehle verwenden, indem Sie die 
Windows- (Windows) bzw. Ctrl-Taste (Mac) 
gedrückt halten, während Sie die Shortcut-Taste 
betätigen. Eine vollständige Liste von 
Tastenkombinationen des Befehls-Tastaturfokus 
finden Sie im Pro Tools-Tastenkombinationen-
Handbuch.

Cliplisten-Tastaturfokus – wenn dieser Fokus 
aktiviert ist, können Sie Audio- und MIDI-Clips 
sowie Clipgruppen in der Clipliste durch Eingabe 
der Anfangsbuchstaben des Clipnamens suchen 
und auswählen.

Gruppenlisten-Tastaturfokus – wenn dieser 
Fokus aktiviert ist, können Sie Mix- und Edit-
Gruppen durch Eingabe der Gruppen-ID (im Mix- 
oder im Edit-Fenster) aktivieren oder deaktivieren.

So legen Sie den Tastaturfokus fest:

 Klicken Sie auf die die Schaltfläche a–z, 
um den entsprechenden Tastaturfokus 
zu aktivieren.

 Drücken Sie eine der folgenden Tasten, 
während Sie Befehl + Wahl (Mac) bzw. Strg + 
Alt (Windows) gedrückt halten: 1 (Befehle), 
2 (Clipliste) oder 3 (Groups-Liste).

Tastaturfokus-Schaltflächen

Obwohl mehrere Plug-In-Fenster einen 
Tastaturfokus aktiviert haben können, gilt die 
Eingabe immer nur für das vorderste Fenster.

Clip List
Tastaturfokus

Gruppenliste
Tastaturfokus

Befehls-Tastaturfokus (Edit-
Fenster)
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Symbolleistenfokus
Im Edit-Fenster kann der MIDI Editor-
Fensterbereich zusätzlich zum Tracks-
Fensterbereich angezeigt werden (View > Other 

Displays > MIDI Editor). Wenn der MIDI Editor-
Fensterbereich eingeblendet ist, enthält das Edit-
Fenster zwei separate Symbolleisten und 
Timelines: für den Tracks-Fensterbereich und für 
den MIDI Editor-Fensterbereich. Es kann jeweils 
nur eine Symbolleiste und Timeline für die Menü- 
und Symbolleistenbefehle (einschließlich der 
entsprechenden Tastenkombinationen) 
gleichzeitig fokussiert werden. Die fokussierte 
Symbolleiste wird gelb umrahmt. 

Wenn der Tastaturfokus für das Edit-Fenster 
aktiviert ist, richtet sich dieser nach dem 
ausgewählten Symbolleistenfokus.

Führen Sie einen der folgenden Schritte aus, um 
den Symbolleistenfokus für den Tracks-
Fensterbereich zu aktivieren:

 Klicken Sie auf die Symbolleiste im oberen 
Bereich des Edit-Fensters.

 Drücken Sie Befehl + Wahl + 4 (Mac) bzw. 
Strg + Alt + 4 (Windows).

Führen Sie einen der folgenden Schritte aus, um 
den Symbolleistenfokus für den MIDI Editor-
Fensterbereich zu aktivieren:

 Klicken Sie auf die Symbolleiste direkt über 
dem MIDI Editor-Fensterbereich.

 Drücken Sie Befehl + Wahl + 5 (Mac) bzw. 
Strg + Alt + 5 (Windows).

Ziffernblockmodus
Die Transport-Funktionen des Ziffernblocks 
werden in den Operation-Voreinstellungen unter 
„Numeric Keypad Mode“ festgelegt.

Es gibt zwei Shuttle Lock-Modi („Classic“ und 
„Transport“) und einen Shuttle-Modus.

Unabhängig davon, welcher Ziffernblockmodus 
aktiviert ist, können Sie über den Ziffernblock 
jederzeit Werte in den Event Edit-Bereich, die 
Edit-Selektions-Anzeigen, die Haupt- und 
Nebenzähler und die Transport-Felder eingeben.

So stellen Sie den Ziffernblockmodus ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Wählen Sie im Transport-Fenster einen 
Ziffernblockmodus (Classic, Transport oder 
Shuttle).

3 Klicken Sie auf OK. 

Shuttle Lock-Modi
Es gibt zwei Shuttle Lock-Modi („Classic“ und 
„Transport“). Bei beiden Modi können Sie den 
Ziffernblock verwenden, um mit einer bestimmten 
Geschwindigkeit vor- oder zurückzuspulen.

• 5 ist normale Geschwindigkeit.

• Mit 6 bis 9 erhalten Sie schnellere Vorspul-
Geschwindigkeiten.

• Mit 4 bis 1 erhalten Sie schnellere Rückspul-
Geschwindigkeiten (4 ist die langsamste 
Geschwindigkeit, 1 die schnellste).

• Drücken Sie 0 zum Anhalten von Shuttle Lock 
und dann die gewünschte Ziffer für die 
Geschwindigkeit.

• Zum Beenden des Shuttle Lock-Modus drücken 
Sie Esc oder die Leertaste.
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Custom Shuttle Lock Speed

(Nur Pro Tools HD)

Die höchste Shuttle-Lock-
Vorspulgeschwindigkeit (Taste 9) kann angepasst 
werden.

Classic-Modus

Dieser Modus emuliert die Funktionsweise von 
Pro Tools in den Versionen vor 5.0. Im Classic-
Ziffernblockmodus ist Folgendes möglich:

• Sie können bis zu zwei Audiospuren im Shuttle 
Lock-Modus wiedergeben. Halten Sie die Ctrl- 
(Mac) bzw. die Windows-Taste (Windows) 
gedrückt und betätigen Sie anschließend für die 
verschiedenen Abspielgeschwindigkeiten eine 
der Tasten 1–9. 

• Drücken Sie Plus oder Minus, um die Richtung 
umzukehren.

• Drücken Sie 0 zum Anhalten von Shuttle Lock 
und dann die gewünschte Ziffer für die 
Geschwindigkeit.

• Zum Beenden des Shuttle Lock-Modus drücken 
Sie Esc oder die Leertaste.

• Sie können Memory Locations aufrufen, indem 
Sie die entsprechende Memory Location gefolgt 
von einem Punkt (.) eingeben.

Transport-Modus

In diesem Modus können Sie eine Reihe von 
Aufnahme- und Wiedergabefunktionen einstellen 
und den Transport über den Ziffernblock steuern.

Wenn sich der Ziffernblock im Transport-Modus 
befindet, ist außerdem Folgendes möglich:

• Sie können bis zu zwei Audiospuren im Shuttle 
Lock-Modus wiedergeben. Halten Sie die Ctrl- 
(Mac) bzw. die Windows-Taste (Windows) 
gedrückt und betätigen Sie anschließend für die 
verschiedenen Abspielgeschwindigkeiten eine 
der Tasten 1–9. 

• Drücken Sie Plus oder Minus, um die Richtung 
umzukehren.

• Drücken Sie 0 zum Anhalten von Shuttle Lock 
und dann die gewünschte Ziffer für die 
Geschwindigkeit.

• Zum Beenden des Shuttle Lock-Modus drücken 
Sie Esc oder die Leertaste.

• Rufen Sie Memory Locations auf, indem Sie 
einen Punkt (.), dann die Nummer der 
entsprechenden Memory Location und 
anschließend wieder einen Punkt (.) eingeben.

Weitere Informationen finden Sie unter 
„Custom Shuttle Lock Speed“ auf Seite 571.

Funktion Key

Metronom-Klick ein/aus 7

Vorzählen ein/aus 8

MIDI Merge/Replace-Modus 9

Loop-Wiedergabe-Modus ein/aus 4

Loop-Aufnahme-Modus ein/aus 5

QuickPunch-Modus ein/aus 6

Rewind 1

Schnellvorlauf (Fast Forward) 2

Scharfschaltung 3

Wiedergabe/Anhalten (Play/Stop) 0
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Shuttle-Modus
(Nur Pro Tools HD)

Pro Tools bietet neben den beiden Shuttle Lock-
Modi noch eine weitere Form des Shuttling. Ist 
der Ziffernblock im Shuttle-Modus, können Sie 
die Wiedergabe der aktuellen Edit-Selektion 
durch Drücken und Halten der entsprechenden 
Tasten des Ziffernblocks starten; sobald Sie die 
Tasten loslassen, wird die Wiedergabe gestoppt. 
Sowohl bei der Vorwärts- als auch bei der 
Rückwärtswiedergabe stehen verschiedene 
Geschwindigkeiten zur Verfügung. Pre- und Post-
Roll werden in diesem Modus ignoriert.

Ist der Ziffernblock-Modus auf Shuttle gesetzt, 
können Sie auch die einzelnen Memory Locations 
aufrufen, indem Sie einen Punkt (.), dann die 
Nummer der entsprechenden Memory Location 
und anschließend wieder einen Punkt (.) eingeben.

Wiedergabegeschwindigkeiten Key

1x Vorlauf 6

1x Rücklauf 4

4x Vorlauf 9

4x Rücklauf 7

1/4x Vorlauf 3

1/4x Rücklauf 1

1/2x Vorlauf 5 + 6

1/2x Rücklauf 5 + 4

2x Vorlauf 8 + 9

2x Rücklauf 8 + 7

1/16x Vorlauf 2 + 3

1/16x Rücklauf 2 + 1

Loop-Selektion (1x) 0

Die Shuttle Lock-Modi stehen nicht zur 
Verfügung, wenn sich der Ziffernblock im 
Shuttle-Modus befindet.
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Kapitel 4: Programmhilfe

Über das Hilfemenü in Pro Tools erhalten Sie 
schnell Zugriff auf die installierte PDF-
Dokumentation und die Online-Hilfe. Das 
Hilfesystem ist HTML-basiert und wird im 
integrierten Pro Tools-Browser geöffnet. 
Es funktioniert auch in herkömmlichen 
Webbrowsern.

Über das Pro Tools-Hilfemenü erhalten Sie über 
den anwendungsinternen Browser auch Zugriff auf 
andere Online-Ressourcen wie die Pro Tools 
Knowledge Base, Avid-Audioforen und das Avid 
Support Center (Internetverbindung erforderlich).

Aufrufen der Handbücher in 
Pro Tools
PDF(Portable Document Format)-Versionen der 
wichtigsten Pro Tools-Handbücher können über 
das Pro Tools-Menü Help aufgerufen werden. 
Zur Anzeige der PDF-Dokumentation wird Adobe 
Reader empfohlen.

So rufen Sie die Handbücher in Pro Tools auf:

 Wählen Sie Help und dann einen 
Handbuchnamen.

In Pro Tools verfügbare Handbücher

Die folgenden Handbücher sind über das Help-
Menü von Pro Tools verfügbar:

Audio-Plug-Ins-Handbuch – Informationen zu 
Plug-Ins, die im Lieferumfang von Pro Tools 
enthalten sind, sowie zu zusätzlichen Plug-Ins, 
die separat erworben werden können.

Pro Tools Reference Guide – eine 
ausführliche Beschreibung von Pro Tools-
Systemen und -Software. 

Pro Tools Shortcuts – Tastatur- und 
Kontextmenü-Tastenkombinationen für 
Pro Tools, einschließlich Pro Tools-Menüs.

Zugreifen auf das Hilfesystem
Sie haben mehrere Möglichkeiten, auf das 
Hilfesystem zuzugreifen.

• Rufen Sie die Hilfe-Startseite über das Help-
Menü in Pro Tools auf.

• Rufen Sie die Hilfe-Startseite in einem Hilfe-
Browser in Pro Tools auf.

• Rufen Sie die Hilfe-Startseite außerhalb von 
Pro Tools auf.

• Rufen Sie die Pro Tools-Hilfe in einer anderen 
Version oder Sprache auf.

Der in Pro Tools integrierte Webbrowser 
ist nicht außerhalb von Pro Tools 
verfügbar. Wenn Sie die Pro Tools-Hilfe 
verwenden möchten, ohne Pro Tools 
auszuführen, verwenden Sie dafür den 
Standardbrowser Ihres Betriebssystems.
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So greifen Sie auf die Hilfe in Pro Tools zu:

 Wählen Sie Help > Pro Tools Help.

 Wählen Sie im Pro Tools Online-
Browserfenster Help.

So rufen Sie die Hilfe außerhalb von Pro Tools auf 
(oder wählen Sie eine andere Version oder 
Sprache aus):

1 Öffnen Sie Ihren bevorzugten Webbrowser 
(beispielsweise Safari oder Internet Explorer).

2 Rufen Sie die Pro Tools-Hilfeseite im Internet 
auf (http://apps.avid.com/ProToolsHelp/).

3 Befolgen Sie zum Öffnen einer bestimmten 
Version der Hilfe die Anweisungen auf dem 
Bildschirm.

So beenden Sie das Hilfesystem:

 Klicken Sie auf die Close-Schaltfläche des 
Hilfe-Fensters.

Hilfeanzeige
Folgende Elemente werden im Hilfesystem 
angezeigt:

Themen  – Hilfethemen werden im rechten 
Teilfenster der Hilfeanzeige geöffnet.

Navigations-Tools – die Registerkarten 
„Contents“, „Index“ und „Search“ werden im 
linken Teilfenster der Hilfeanzeige geöffnet.

Hierarchie-Links – mithilfe dieser Links können 
Sie nachvollziehen, wo sich das aktuell angezeigte 
Thema im jeweiligen Kapitel befindet und zu 
Themen übergeordneter Ebenen (einschließlich 
der Hauptthemen) springen.

Show in Contents-Schaltfläche – mithilfe dieser 
Schaltfläche können Sie das aktuelle Thema im 
Inhaltsverzeichnis anzeigen lassen.

Schaltflächen „Previous Topic“ und „Next 
Topic“– mithilfe dieser Schaltflächen können Sie 
die Themen in der Reihenfolge durchsuchen, in der 
sie im Inhaltsverzeichnis aufgeführt werden. 

Print – klicken Sie auf die Schaltfläche, wenn Sie 
eines oder mehrere Themen ausdrucken möchten. 

Verwenden der Contents- und 
Index-Registerkarten
Im linken Teilfenster der Hilfe werden die meisten 
Navigationstools des Hilfesystems angezeigt, 
zum Beispiel die Registerkarten „Contents“ und 
„Index“.

Contents-Registerkarte
Auf der Contents-Registerkarte werden alle 
Themen im Hilfesystem hierarchisch aufgeführt. 
Dadurch erhalten Sie einen schnellen Überblick 
zum Hilfesystem. 

Sie können die Anzeige der Contents-
Registerkarte erweitern oder reduzieren, um den 
logischen Aufbau des Hilfesystems zu sehen, 
und durch Klicken auf den entsprechenden Eintrag 
zu Themen navigieren.

Wenn Sie zu einem neuen Thema wechseln, wird 
die Struktur der Registerkarte auf der Ebene dieses 
Themas erweitert und das Thema hervorgehoben. 
Mithilfe dieser Funktion können Sie ähnlich 
wie bei den hierarchischen Links oberhalb jedes 
Themas sehen, wo genau sich das aktuelle 
Thema in der logischen Struktur des 
Hilfesystems befindet.
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So zeigen Sie ein Thema auf der Contents-
Registerkarte an:

 Klicken Sie auf die Contents-Registerkarte und 
anschließend auf den Eintrag des gewünschten 
Themas. 

So erweitern Sie einen Abschnitt der Contents-
Registerkarte:

 Klicken Sie auf die Contents-Registerkarte und 
anschließend auf das Buchsymbol links neben 
einem Link. 

Index-Registerkarte
Der Index enthält eine alphabetische Liste aller 
Einträge, ähnlich wie der Index eines gedruckten 
Buches. 

Wenn Java im Browser aktiviert ist, zeigt der 
Index einen dynamischen Index, bei dem die Liste 
während der Eingabe eines Worts im Textfeld 
automatisch durchsucht wird. Wenn Java im 
Browser nicht aktiviert ist oder wenn der Browser 
keine Java-Implementierungen unterstützt, wird 
eine JavaScript-Version des Index angezeigt, 
bei der Sie manuell durch die Einträge blättern 
können.

So finden Sie Themen auf der Index-Registerkarte:

1 Klicken Sie auf die Index-Registerkarte. 

2 Klicken Sie auf das erste Zeichen des Themas in 
der „Numerics, Letters, Symbols“-Liste.

So rufen Sie das mit einem Index-Eintrag 
verknüpfte Thema auf:

 Klicken Sie auf den Index-Eintrag.

Verwenden der Search-
Registerkarte
Auf der Search-Registerkarte können Sie den 
gesamten Text des Hilfesystems nach einem oder 
mehreren Wörtern durchsuchen und anschließend 
eine Liste der Themen anzeigen, die diese Wörter 
enthalten. Die Liste der Suchergebnisse wird so 
sortiert, dass jene Themen zuerst angezeigt 
werden, deren Relevanz von der Suchfunktion am 
höchsten eingestuft wird.

Wenn Sie nach Text suchen, wird die 
entsprechende Textzeichenfolge standardmäßig 
automatisch hervorgehoben. Sie können diese 
Hervorhebung rückgängig machen. Sie können die 
Hervorhebungen nach der Suche auch aufheben, 
indem Sie mithilfe der Zurück- und Vorwärts-
Schaltfläche zu einem anderen Thema wechseln. 
Wenn Sie anschließend wieder zu dem gesuchten 
Thema zurückgelangen, wird die Hervorhebung 
nicht länger angezeigt.

Weitere Richtlinien zur effektiven Verwendung 
der Suchfunktion finden Sie unter „Richtlinien für 
die Suche“ auf Seite 34.

So führen Sie eine Standardsuche durch:

1 Klicken Sie auf die Search-Registerkarte. 

2 Wählen Sie durch Klicken auf die entsprechende 
Option im Search-Popup-Menü (unterhalb des 
Suchtextfelds), ob Sie alle Handbücher (All 
Availabe Books) oder ein bestimmtes Handbuch 
(beispielsweise das Handbuch zu den Pro Tools-
Tastenkombinationen) durchsuchen möchten.

3 Geben Sie im Suchtextfeld den Begriff ein, 
nach dem Sie suchen möchten. 

4 Klicken Sie auf „Go“.

Eine nummerierte Themenliste wird angezeigt.
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Weitere Informationen zur Suche

Die Suchfunktion eignet sich optimal, um schnell 
hilfreiche Ergebnisse zu erhalten.

• Die Suchfunktion verwendet eine Datenbank 
mit gültigen Wörtern. Diese Datenbank enthält 
alle Wörter, die zum Identifizieren von Themen 
dienen, und schließt alle anderen Wörter aus. 
Wenn Sie Wörter im Suchfeld eingeben, werden 
alle ungültigen Wörter vom System ignoriert 
und nur gültige Wörter gesucht.

• Die Suchfunktion kann nicht nach Wörtern in 
einer bestimmten Reihenfolge suchen. Wenn Sie 
beispielsweise „TIFF graphics import“ als 
Suchbegriff eingeben, zeigt die Suche alle 
Themen an, die diese drei Wörter unabhängig 
von ihrer Position im Thema enthalten. In den 
Ergebnissen werden Themen angezeigt, 
bei denen diese drei Wörter gemeinsam als 
Begriff oder vereinzelt im Thema vorkommen.

• Die Suchfunktion kann nicht zwischen Wörtern 
unterscheiden, die ähnlich, aber nicht identisch 
sind. Wenn Sie beispielsweise „capture“ als 
Suchbegriff eingeben, zeigt die Suche Themen 
an, die dieses Wort enthalten, aber keine 
Themen, die ähnliche Wörter wie „captures“ 
oder „capturing“ enthalten. Wenn bei einer 
Suche keine hilfreichen Ergebnisse angezeigt 
werden, kann eine Suche nach ähnlichen 
Wörtern sinnvoll sein.

Richtlinien für die Suche
Verwenden Sie die folgenden Regeln für 
Suchanfragen: 

• Bei der Suche wird nicht zwischen Groß- und 
Kleinschreibung unterschieden. 

• Sie können nach jeder beliebigen Kombination 
aus Buchstaben- (a–z) und Zahlenkombination 
(0–9) suchen. 

• Satzzeichen (Punkt, Doppelpunkt, Semikolon, 
Komma und Bindestrich) werden ebenfalls nicht 
bei der Suche beachtet, es sei denn, sie sind Teil 
des Suchbegriffs (wie bei „.WAV“). 

• Mithilfe von Anführungszeichen können Sie 
nach ganzen Sätzen suchen. Sie können jedoch 
nicht nach Anführungszeichen selbst suchen. 

Kopieren aus Hilfethema
Sie können Informationen aus einem Hilfethema 
in ein anderes Dokument (beispielsweise eine 
Textdatei) kopieren.

So kopieren Sie Informationen von einem 
Hilfethema in ein anderes Dokument:

1 Öffnen Sie ein Thema oder klicken Sie darauf, 
um es zu aktivieren.

2 Wählen Sie die Textpassagen, die Sie kopieren 
möchten.

3 Wählen Sie Edit > Copy.

4 Setzen Sie den Mauszeiger in eine andere 
Anwendung, beispielsweise ein 
Textverarbeitungsprogramm.

5 Wählen Sie Bearbeiten > Einfügen, um den 
kopierten Text in ein Dokument einzufügen. 
(Sie können den Text auch in das Suchfeld 
einfügen.)
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Drucken von Hilfethemen
Sie können Hilfethemen drucken, wenn Sie diese 
während eines komplizierten Vorgangs oder zu 
einem späteren Zeitpunkt benötigen.

Weitere Informationen zu Druckoptionen finden 
Sie in der Dokumentation zu Ihrem Browser.

So drucken Sie ein Hilfethema:

1 Klicken Sie in dem zu druckenden 
Browserfenster auf das Themen-Teilfenster.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie im Themen-Teilfenster auf die 
Print-Schaltfläche.

• Klicken Sie mit der rechten Maustaste auf das 
Themen-Teilfenster und wählen Sie „Print“.

• Wählen Sie File > Print.

3 Legen Sie die Optionen für das Drucken fest.

4 Klicken Sie auf Print.

Bei Themen, die Sie aus der Hilfe drucken 
möchten, stehen begrenzte Seitenlayout- und 
Formatierungsoptionen zur Verfügung. 
Wenn Sie Informationen aus der Hilfe in 
einer besseren Qualität ausdrucken möchten, 
empfiehlt Avid, die gesamte PDF-Version 
oder Teile des entsprechenden Handbuchs 
ausdrucken.
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Teil II: Systemkonfiguration
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Kapitel 5: Pro Tools-Systeme

Es gibt drei Arten von Pro Tools-Systemen:

Pro Tools-Software mit Hardware von Avid oder 
anderen Herstellern

Zu diesen Systemen gehört Pro Tools-Software 
zusammen mit Audio-Interfaces der Produkt-
familien Avid 003™, Eleven® Rack, Mbox® 
(dritte Generation) und Mbox 2. Die in diesen 
Systemen enthaltene Pro Tools-Software kann 
auch mit Audio-Interfaces anderer Hersteller 
eingesetzt werden, die Core Audio-Treiber 
(Mac, einschließlich der im Mac integrierten 
Audiofunktionen) oder ASIO-Treiber 
(Windows) unterstützen.

Pro Tools HD-Software mit Pro Tools|HDX- 
oder Pro Tools|HD Native-Hardware

Zu den Hardware-beschleunigten Pro Tools HD-
Systemen gehört Pro Tools HD-Software 
zusammen mit HDX- oder HD Native-Hardware 
(PCIe oder Thunderbolt). Systeme mit 
Hardwarebeschleunigung bieten erweiterte 
Anschlussmöglichkeiten und Niedriglatenz-
Monitoring. Pro Tools|HDX-Systeme bieten 
DSP-Leistung eigens für Plug-In-Verarbeitung 
und große Mixer-Konfigurationen.

Pro Tools HD-Software mit Hardware von Avid 
oder anderen Herstellern

Zu diesen Systemen zählt Pro Tools HD-Software 
mit einem beliebigen nicht-HDX- oder nicht-
HD Native-Audio-Interface von Avid (etwa Mbox 
Pro), oder mit Core Audio-Hardware (Mac) bzw. 
ASIO-Hardware (Windows). 

Eine Liste der qualifizierten Audio-Interfaces 
und Computer für alle Pro Tools-Systeme 
finden Sie unter: www.avid.com/compatibility.
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Pro Tools-Software
Pro Tools-Software bietet – in Abhängigkeit 
von Ihrer Hardware-Konfiguration – die 
folgenden Funktionen:

• bis zu 32 Ein- und Ausgangskanäle je nach 
System und Audio-Hardware

• bis zu 96 Mono- oder Stereo-Audiospuren 
(bis zu 128 spielbare Audiospuren) pro Session:

• Wiedergabe von bis zu 96 Spuren oder 
Kombination aus Wiedergabe und Aufnahme 
von bis zu 96 Spuren, mono oder stereo, 
bei 44,1 kHz und 48 kHz

• Wiedergabe von bis zu 48 Spuren oder 
Kombination von Wiedergabe und Aufnahme 
von bis zu 48 Spuren, mono oder stereo, 
bei 88,2 kHz und 96 kHz

• Wiedergabe von bis zu 24 Spuren oder 
Kombination aus Wiedergabe und Aufnahme 
von bis zu 24 Spuren, mono oder stereo, 
bei 176,4 kHz und 192 kHz

• bis zu 128 Auxiliary-Eingangs-Spuren

• bis zu 64 Master-Fader-Spuren

• bis zu 512 MIDI-Spuren

• bis zu 128 Instrumentenspuren

• eine QuickTime-Videospur

• 16-Bit-, 24-Bit- oder 32-Bit-Audioauflösung 
mit Gleitkommaverarbeitung und Samplerates 
bis zu 192 kHz

• automatischer Verzögerungsausgleich (bis zu 
16.383 Samples bei 48 kHz)

• nicht destruktiver, direkter Zugriff auf 
Audiomaterial und Mischautomation

• Audiobearbeitung mit bis zu 10 Echtzeit-Plug-
Ins pro Spur (abhängig von den 
Leistungsmerkmalen Ihres Computers)

• bis zu 10 Hardware-Inserts pro Spur

• bis zu 10 Sends pro Spur

• bis zu 256 interne Busse für Routing und Mixing

Unterstützte Hardware-
Konfigurationen mit 
Pro Tools-Software
Pro Tools unterstützt die folgenden 
Hardware-Konfigurationen:

003-Produktfamilie

Pro Tools-Software mit Hardware der 003-Familie 
unterstützt bis zu 18 Ein- und Ausgangskanäle 
bei Samplerates von bis zu 48 kHz und bis zu 
10 Ein- und Ausgangskanäle bei Samplerates 
von bis zu 96 kHz. Ein 003-System enthält:

• Pro Tools-Software

• Wahlweise:

• 003-Audio- und MIDI-Interface 
(mit Bedienoberfläche)

• 003 Rack+-Audio- und MIDI-Interface

• 003 Rack-Audio- und MIDI-Interface

Weitere Informationen über die 
Anschlussmöglichkeiten Ihres Audio-
Interface mit Pro Tools erhalten Sie in 
der mit Ihrem Audio-Interface 
gelieferten Dokumentation.
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Eleven Rack

Pro Tools-Software mit Eleven Rack-Hardware 
unterstützt bis zu 8 Eingangskanäle und bis zu 
6 Ausgangskanäle bei Samplerates von bis zu 
88,2 oder 96 kHz. Ein Eleven Rack-
System enthält:

• Pro Tools-Software

• Eleven Rack Audio- und MIDI-Interface und 
Gitarren-Effektprozessor

Mbox-Produktfamilie

Ein Mbox-System enthält:

• Pro Tools-Software

• Wahlweise:

• Mbox Pro (3. Generation): bis zu 8 Ein- 
und Ausgangskanäle bei Samplerates von 
44,1 oder 48 kHz und bis zu 6 Ein- und 
Ausgangskanäle bei Samplerates von 
176,4 oder 192 kHz

• Mbox (3. Generation): bis zu 4 Ein- und 
Ausgangskanäle bei Samplerates von 
44,1 oder 48 kHz und bis zu 2 Ein- und 
Ausgangskanäle bei Samplerates von 
88,2 oder 96 kHz

• Mbox Mini (3. Generation) oder 
Mbox 2 Mini: bis zu 2 Ein- und 
Ausgangskanäle bei Samplerates von 
44,1 oder 48 kHz

• Mbox 2 Pro: bis zu 6 Eingangskanäle und 
8 Ausgangskanäle bei Samplerates von 
44,1 oder 48 kHz und bis zu 4 Eingangskanäle 
und 6 Ausgangskanäle bei Samplerates von 
88,2 oder 96 kHz

• Mbox 2: bis zu 2 Ein- und Ausgangskanäle 
bei Samplerates von 44,1 oder 48 kHz

• Mbox 2 Micro: nur Stereoausgang bei 
Samplerates von 44,1 oder 48 kHz

Core Audio

Pro Tools-Software mit Core Audio-kompatibler 
Hardware unterstützt je nach Audio-Interface bis 
zu 32 Ein- und Ausgangskanäle bei Samplerates 
von bis zu 192 kHz. Ein Pro Tools Core Audio-
System enthält:

• Pro Tools-Software

• Ein Audio-Interface eines anderen Herstellers, 
das Core Audio-Treiber unterstützt (einschließlich 
integrierter Mac-Audio-Hardware)

ASIO

Pro Tools-Software mit ASIO-kompatibler 
Hardware unterstützt je nach Audio-Interface 
bis zu 32 Ein- und Ausgangskanäle bei 
Samplerates von bis zu 192 kHz. Ein Pro Tools 
ASIO-System enthält:

• Pro Tools-Software

• ein Audio-Interface eines anderen Herstellers, 
das ASIO-Treiber unterstützt

Verarbeitungsleistung

Die Verarbeitungsleistung von Pro Tools-
Systemen hängt von der Prozessorleistung Ihres 
Rechners ab. Fragen Sie Ihren Händler oder 
besuchen Sie www.avid.com, um die aktuellsten 
Informationen zu Systemanforderungen und 
Kompatibilität zu erhalten.

Pro Tools-Systemfunktionen 
mit unterschiedlichen 
Hardware-Konfigurationen

Pro Tools unterstützt bis zu 32 Ein- und 
Ausgangskanäle, die verfügbaren Anschlussmög-
lichkeiten in Pro Tools variieren jedoch je nach 
Ihrem Audio-Interface. Informationen über die 
Anschlussmöglichkeiten Ihres Audio-Interface 
erhalten Sie in der mit Ihrer Hardware 
gelieferten Dokumentation.



Pro Tools-Referenzhandbuch42

Wenn Sie eine Pro Tools-Session öffnen, die auf 
einem Pro Tools HD-System erstellt wurde und 
mehr Spuren enthält, als auf Ihrem Pro Tools-
System unterstützt werden, werden die Audio-
spuren, die die Höchstzahl der möglichen 
spielbaren Spuren überschreiten, 
automatisch deaktiviert.

Pro Tools HD mit 
HDX-Hardware
Für jedes System wird mindestens ein Avid HD-
Audio-Interface benötigt (separat erhältlich). 
HDX-Systeme können durch den Einbau 
zusätzlicher HDX-Karten und den Anschluss 
zusätzlicher Audio-Interfaces erweitert werden, 
um die maximale Spurenanzahl und Bearbeitungs-
geschwindigkeit für Plug-Ins und Mixer 
zu erhöhen.

Pro Tools HD-Software-
funktionen mit HDX-Hardware 
Pro Tools HD mit HDX-Hardware unterstützt die 
folgenden Anschlussmöglichkeiten:

• bis zu 256 Ein- und Ausgangskanäle je 
nach System

• bis zu 768 spielbare Audiospuren insgesamt

• bis zu 512 Auxiliary-Eingangs-Spuren

• bis zu 64 Master-Fader-Spuren

• bis zu 128 VCA-Master-Spuren

• bis zu 512 MIDI-Spuren

• bis zu 256 Instrumentenspuren

• bis zu 64 Videospuren pro Session

• 16-Bit-, 24-Bit- oder 32-Bit-Audioauflösung 
mit Gleitkommaverarbeitung und Samplerates 
bis zu 192 kHz

• Surround-Mischungen bis 7.1

• automatischer Verzögerungsausgleich (bis zu 
16.348 Samples bei 48 kHz)

• Feste Zuweisung eines RAM-Festplatten-Cache

• latenzfreies Monitoring

• nicht destruktiver, direkter Zugriff auf 
Audiomaterial und Mischautomation

• Audioverarbeitung mit bis zu 10 Inserts pro 
Spur (alle Kombinationen von Echtzeit-Plug-Ins 
und Hardware-Inserts möglich), abhängig von 
den Leistungsmerkmalen Ihres Computers

• bis zu 10 Sends pro Spur

• bis zu 512 interne Busse für Routing und Mixing

Aufnahme und Wiedergabe

Die Anzahl gleichzeitiger Spuren bei der 
Aufnahme oder Wiedergabe von Audiomaterial 
hängt von Ihrer Systemkonfiguration ab. 
Bei einem Pro Tools HD-System mit einer HDX-
Karte können 24-Bit- und 16-Bit-Audiodateien 
bei folgender Spurenanzahl aufgenommen und 
wiedergegeben werden:

• bis zu 256 Spuren bei 44,1 kHz oder 48 kHz

• bis zu 128 Spuren bei 88,2 kHz oder 96 kHz

• bis zu 64 Spuren bei 176,4 kHz oder 192 kHz

Mit jeder zusätzlichen HDX-Karte erhöht sich 
die Anzahl verfügbarer Spuren um den jeweils 
angegeben Wert. Beispielsweise sind bei zwei 
HDX-Karten und Samplerates von 44,1 kHz bis zu 
512 Audiospuren verfügbar, bei drei HDX-Karten 
bis zu 768 Audiospuren.

Weitere Informationen zum Übertragen 
von Session-Material zwischen Pro Tools 
HD- und Pro Tools-Systemen finden Sie 
unter „Austauschen von auf verschiedenen 
Plattformen erstellten Sessions“ auf 
Seite 393.
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Pro Tools HD-Software mit 
HD Native-Hardware
Für jedes System wird mindestens ein 
Avid HD-Audio-Interface benötigt (separat 
erhältlich). HD Native-Systeme können durch 
den Einbau zusätzlicher HD-Audio-Interfaces 
erweitert werden.

Pro Tools HD-Systeme mit HD Native-
Hardware enthalten:

• Wahlweise:

• HD Native-PCIe-Karte

• HD Native Thunderbolt-Interface

• Pro Tools HD-Software

• Einen bereits autorisierten iLok für 
Pro Tools HD-Software

• ein oder mehrere Avid HD-Audio-Interfaces 
(separat erhältlich)

• DigiLink Mini-Kabel zum Anschluss von 
HD Native-Hardware an ein Audio-Interface

• ein MIDI-Interface (optional)

Pro Tools HD-
Softwarefunktionen mit 
HD Native-Hardware
Pro Tools HD mit HD Native-Hardware 
auf Mac oder Windows bietet folgende 
Anschlussmöglichkeiten:

• bis zu 64 Ein- und Ausgangskanäle je nach 
System sowie Anzahl und Typ der installierten 
Audio-Interfaces

• bis zu 256 Audiospuren (bis zu 768 spielbare 
Audiospuren insgesamt):

• bis zu 256 Voices bei 44,1 kHz oder 48 kHz

• bis zu 128 Voices bei 88,2 kHz oder 96 kHz

• bis zu 64 Voices bei 176,4 kHz oder 192 kHz

• bis zu 512 Auxiliary-Eingangs-Spuren

• bis zu 64 Master-Fader-Spuren

• bis zu 128 VCA-Master-Spuren

• bis zu 512 MIDI-Spuren

• bis zu 256 Instrumentenspuren

• bis zu 64 Videospuren pro Session

• 16-Bit-, 24-Bit- oder 32-Bit-Audioauflösung 
mit Gleitkommaverarbeitung und Samplerates 
bis zu 192 kHz

• nicht destruktiver, direkter Zugriff auf 
Audiomaterial und Mischautomation

• Surround-Mischungen bis 7.1

• automatischer Verzögerungsausgleich (bis zu 
16.348 Samples bei 48 kHz)

• Feste Zuweisung eines RAM-Festplatten-Cache

• FPGA-basiertes Niedriglatenz-Monitoring (LLM)

• Audioverarbeitung mit bis zu 10 Inserts pro Spur 
(alle Kombinationen von hostbasierten Echtzeit-
Plug-Ins und Hardware-Inserts möglich), 
abhängig von den Leistungsmerkmalen Ihres 
Computers sowie Anzahl und Typ der 
installierten Audio-Interfaces

• bis zu 10 Sends pro Spur

• bis zu 256 interne Busse für Routing und Mixing

Detaillierte Informationen zur Installation 
von HD Native PCIe-Hardware finden Sie im 
HD Native-Installationshandbuch. 
Informationen zur Installation von HD Native 
Thunderbolt-Hardware finden Sie im HD 
Native Thunderbold-Installationshandbuch.
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Unterstützte Avid HD-
Audio-Interfaces
Die folgenden Avid HD-Audio-Interfaces sind mit 
Avid HDX- und HD Native-Hardware kompatibel:

• HD I/O

• HD OMNI

• HD MADI

Maximale I/O-Konfiguration 
mit HDX
HDX unterstützt in einer Maximalkombination bis 
zu 12 der folgenden Audio-Interfaces: 

• HD OMNI (pro System wird nur 1 HD 
OMNI-Interface unterstützt)

• HD I/O (es können bis zu 12 HD I/O-Interfaces 
gleichzeitig verwendet werden – 3 HDX-Karten 
erforderlich)

• HD MADI (es können bis zu 3 HD 
MADI-Interfaces gleichzeitig verwendet 
werden – 3 HDX-Karten erforderlich)

Maximale I/O-Konfiguration mit 
HD Native
HD Native unterstützt in einer 
Maximalkombination bis zu 4 der folgenden 
Audio-Interfaces: 

• HD OMNI (pro HD Native-System wird nur 
1 HD OMNI-Interface unterstützt)

• HD I/O (es können bis zu 4 HD I/O-Interfaces 
gleichzeitig verwendet werden)

• HD MADI (wenn beide DigiLink-Anschlüsse 
von HD MADI mit beiden DigiLink-
Anschlüssen an der HD Native PCIe-Karte oder 
dem Thunderbolt-Interface verbunden sind, kann 
mit einem HD MADI-Interface die maximal 
mögliche I/O-Anzahl angeschlossen werden).

Avid HDX- und HD Native-Systeme erfordern 
mindestens ein HD I/O-, HD OMNI- oder 
HD MADI-Audio-Interface.
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Wiedergabe-, Aufnahme- und Voice-Limits bei Pro Tools HD
In der nachstehenden Tabelle sind die Beschränkungen bei Audiowiedergabe, -aufnahme und Voices für 
Pro Tools HD-Software mit HDX-, HD Native-, Core Audio- und ASIO-Hardware aufgeführt. Voices für 
Aufnahme und Wiedergabe bezieht sich auf die Anzahl der einzelnen Spuren, die im System gleichzeitig 
wiedergegeben oder aufgenommen werden können. Spielbare Spuren insgesamt bezieht sich auf die 
maximale Anzahl von Audiospuren, die die verfügbaren Voices auf Ihrem System gemeinsam nutzen 
können. (Monospuren sind für eine Voice bestimmt. Stereo- und Mehrkanalspuren können für maximal 
eine Voice pro Kanal genutzt werden.)

Bei HDX-Hardwarebeschleunigung hängt die maximale Anzahl der Voices von der Samplerate der Session 
und der Anzahl der für die Playback Engine des Systems eingesetzten DSP-Chips ab. Auf Pro Tools HD 
können zwar Sessions mit bis zu 768 Audiospuren geöffnet werden, jedoch werden alle Audiospuren, die 
über die maximal mögliche Anzahl der spielbaren Spuren hinausgehen, automatisch auf Voice Off gestellt.

 

Audiowiedergabe-/Aufnahme- und Voice-Limits in Pro Tools HD nach Hardware-Konfiguration

Core-System Maximale I/O
Samplerate 
(kHz)

Voices für 
Aufnahme und 
Wiedergabe 
(Monospuren 
für simultane 
Wiedergabe 
und Aufnahme)

Spielbare 
Spuren 
insgesamt

HDX, 1 Karte 64 Kanäle 44,1/48 256 768

88,2/96 128 768

176,4/192 64 768

HDX, 2 Karten 128 Kanäle 44,1/48 512 768

88,2/96 256 768

176,4/192 128 768

HDX, 3 Karten 192 Kanäle 44,1/48 1024 768

88,2/96 512 768

176,4/192 128 768
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Features der Avid HD-Audio-Interfaces
In der folgenden Tabelle ist die Anzahl der Ein- und Ausgänge der verschiedenen Avid HD-Audio-Interfaces 
für Avid HDX- und HD Native-Systeme aufgeführt. Jede HDX-Karte in Ihrem System unterstützt maximal 
je 64 I/O-Kanäle. Die HD Native-Hardware unterstützt maximal 64 I/O-Kanäle. Für die Aufzeichnung und 
Wiedergabe von Audio mit Pro Tools HD bei einer dieser Hardware-konfigurationen muss mindestens ein 
Avid HD-Audio-Interface mit dem ersten Anschluss an der ersten Karte (oder dem Thunderbolt-Interface) 
des Systems verbunden sein.

HD Native 64 Kanäle 44,1/48 256 768

88,2/96 128 768

176,4/192 64 768

Core Audio und ASIO 
(Pro Tools HD)

32 Kanäle 44,1/48 256 768

88,2/96 128 768

176,4/192 64 768

Audiowiedergabe-/Aufnahme- und Voice-Limits in Pro Tools HD nach Hardware-Konfiguration

Core-System Maximale I/O
Samplerate 
(kHz)

Voices für 
Aufnahme und 
Wiedergabe 
(Monospuren 
für simultane 
Wiedergabe 
und Aufnahme)

Spielbare 
Spuren 
insgesamt

Kanalkapazitäten der Avid HD-Audio-Interfaces

Interface-Typ
Anzahl 
I/O-Kanäle

Samplerates 
(kHz)

A/D-
Umwandlung

D/A-
Umwandlung

Digitale 
Ein- und 
Ausgänge

HD I/O je 16 Ein-/ 
Ausgänge

44,1, 48, 88,2, 96, 
176,4, 192

24 Bit 24 Bit 24 Bit

HD OMNI je 8 Ein-/ 
Ausgänge

44,1, 48, 88,2, 96, 
176,4, 192

24 Bit 24 Bit 24 Bit

HD MADI je 64 Ein-/ 
Ausgänge

44,1, 48, 88,2, 96, 
176,4, 192

None None 24 Bit
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HD OMNI: Audio-Interface
HD OMNI ist ein für die Verwendung mit Avid 
HD-Systemen entwickeltes professionelles 
digitales Audio-Interface. HD OMNI ist eine 
kompakte Vorverstärker-, Monitoring- und I/O-
Lösung für die Musikaufnahme und -produktion 
sowie für Postproduktionsstudios.

HD OMNI-Features

HD OMNI bietet bis zu acht getrennte Kanäle 
für Pro Tools-Ein- und Ausgänge sowie LED-
Aussteuerungsanzeigen (mit je vier Segmenten) 
pro Kanal. 

Analoge Ein- und Ausgänge

• A/D-Wandler und D/A-Wandler mit 24 Bit, 
Unterstützung von Samplerates bis zu 192 kHz

• 2 hochwertige Mic-/DI-Preamps (Kanal 1–2)

• 2 Mikrofon-/Instrumenteneingänge auf der 
Gerätevorderseite (Combo-Buchsen XLR und 
6,3-mm-Stereoklinke)

• 2 Mikrofoneingänge auf der 
Geräterückseite (XLR)

• Jeweils 2 Insert-Sends/-Returns (6,3-mm-
Stereoklinke) auf der Geräterückseite für 
Hardware-Inserts auf Kanäle 1 und 2

• 4 analoge Line-Eingänge hinten (6,3-mm-
Stereoklinke, TRS, Kanal 1–4)

• Soft Clip- und Curve-Limiter verhindern 
Übersteuerung analoger Eingangssignale

• 8 analoge Ausgangskanäle hinten über DB-
25-Breakout-Kabel (separat erhältlich) mit 
variabler Ausgangsverstärkung

• 2 analoge Ausgangskanäle hinten (TRS) spiegeln 
Kanäle 1–2 oder 7–8 auf DB-25-Anschluss

• 6,3-mm-Stereo-Kopfhörerbuchse vorne

Digitale Ein- und Ausgänge

• 8 AES/EBU-Ausgangskanäle (bis zu 192 kHz, 
Single Wire) über DB-25-Breakout-Kabel 
(separat erhältlich)

• 2 AES/EBU-Eingangskanäle (XLR, bis zu 
192 kHz, Single Wire)

• 2 S/PDIF-Cinch-Ein- und Ausgangskanäle 
(bis zu 192 kHz)

• 8 ADAT-Ein- und Ausgangskanäle (TOSLINK)

• Unterstützung für optische ADAT S/MUX-
Anschlüsse für Samplerates von 88,2 kHz, 
96 kHz, 176,4 kHz und 192 kHz

• Unterstützung für zwei optische S/PDIF-Kanäle 
mit Samplerates bis 96 kHz

• Samplerate-Konvertierung (Sample Rate 
Conversion, SRC) in Echtzeit bei den digitalen 
Eingängen 1–2 (entweder AES/EBU, S/PDIF 
oder optisches S/PDIF)

Abhören von

• Zusätzlicher Stereo-Ausgangspfad (CUE) 
in Pro Tools® zum Abhören über Kopfhörer 
mithilfe der Kopfhörerbuchse an der Vorderseite

• Lautstärkeregelung für Control Room 
(MAIN/ALT) und Kopfhörer vorne

• Flexibles Monitoring mit Downmixing 
aller Stereo- und Surround-Formate 
(bis 7.1-Surround)

• Input Mixer für latenzarmes direktes 
Abhören einer Vielzahl von Eingangssignalen 
(Konfiguration im Pro Tools-Hardware-Setup)

Synchronization

• Loop Sync-Eingang und -Ausgang zum 
Anschluss zusätzlicher HD-Peripheriegeräte

• Ein- und Ausgang für externen Taktgeber zur 
Synchronisation von HD OMNI mit externen 
Wordclock-Geräten

HD OMNI bietet mehrere analoge 
Eingangsverbindungen, jedoch sind höchstens 
vier Kanäle für analoge Eingangssignale für 
Pro Tools gleichzeitig möglich.

Samplerate-Konvertierung wird bei 
ADAT S/MUX nicht unterstützt.

Weitere Informationen hierzu finden Sie im 
HD OMNI-Handbuch.
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HD I/O-Audio-Interface
HD I/O ist ein für die Verwendung mit Avid HD-
Systemen entwickeltes digitales Mehrkanal-
Audio-Interface. HD I/O ist mit besonders 
hochklassigen A/D- und D/A-Wandlern (24 Bit) 
ausgestattet und unterstützt Samplerates bis 
zu 192 kHz. 

HD I/O wird in drei Standardkonfigurationen 
angeboten:

• 8 x 8 x 8 (8 analoge Eingänge, 8 analoge 
Ausgänge und 8 digitale Ein- und Ausgänge)

• Je 16 analoge Ein- und Ausgänge

• Je 16 digitale Ein- und Ausgänge

Für eine individuelle Konfiguration 
können HD I/O Analog-Erweiterungskarten 
(A/D-Wandler und D/A-Wandler) und HD I/O 
Digital-Erweiterungskarten hinzugefügt oder 
entfernt werden. 

HD I/O-Features

HD I/O bietet bis zu sechzehn getrennte Kanäle 
für Pro Tools-Ein- und Ausgänge sowie LED-
Aussteuerungsanzeigen (mit je vier Segmenten) 
für jeden Kanal. 

Analoge Ein- und Ausgänge

• Bis zu 16 A/D- und D/A-Wandler mit 24 Bit für 
hochwertige analoge Eingangs- und 
Ausgangssignale und Samplerates von 
44,1 kHz, 48 kHz, 88,2 kHz, 96 kHz, 176,4 kHz 
und 192 kHz mit Analog In- und Analog Out-
HD I/O-Karten

• Soft Clip- und Curve-Limiter verhindern 
Übersteuerung analoger Eingangssignale

Digitale Ein- und Ausgänge

• Bis zu 16 Kanäle mit digitalen Ein- und 
Ausgängen bei einer Auflösung von 24 Bit im 
AES/EBU-, TDIF DB-25- oder optischen 
Format bei Samplerates von 44,1 kHz, 48 kHz, 
88,2 kHz, 96 kHz, 176,4 kHz und 192 kHz mit 
einer Digital HD I/O-Karte

• Samplerate-Konvertierung in Echtzeit auf 
digitalen Eingängen mit einer Digital I/O-Karte 
(bis zu sechzehn Kanäle AES/EBU, TDIF 
oder optisch)

• Unterstützung für optische S/MUX-Signale bei 
Samplerates ab 88,2 kHz

• Unterstützung für 2 optische S/PDIF-Kanäle 
(integriert) mit Samplerates bis 96 kHz

• 2 AES/EBU-I/O-Kanäle (integriert), 
Unterstützung für Samplerates bis 192 kHz

• 2 S/PDIF-I/O-Kanäle mit 24-Bit-Kapazität 
(integriert), Unterstützung für Samplerates bis 
192 kHz

Synchronization

• Loop Sync-Eingang und -Ausgang zum 
Anschließen zusätzlicher Avid HD-Interfaces 
und -Peripheriegeräte

• Ein- und Ausgang für externen Taktgeber zur 
Synchronisation von HD I/O mit externen 
Wordclock-Geräten

Erweiterbarkeit

• optionales Hinzufügen von I/O-Karten zur 
Erweiterung der analogen oder digitalen Ein- 
und Ausgänge

• Gleichzeitiger Einsatz mehrerer Avid HD-
Audio-Interfaces für zusätzliche Erweiterung 
der Systemein- und -ausgänge

Weitere Informationen hierzu finden Sie im 
HD I/O-Handbuch.
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HD MADI: digitales 
Audio-Interface
HD MADI ist ein für die Verwendung mit 
Avid HD-Systemen entwickeltes digitales Audio-
Interface mit 64 Kanälen. HD MADI unterstützt 
das Multichannel Audio Digital Interface-Format 
(MADI) und Samplerates bis 192 kHz. HD MADI 
erleichtert es, Avid HD-Systeme mit MADI-
kompatiblen Audiogeräten zu verbinden.

HD MADI-Features
• Zwei MADI-Eingänge und zwei MADI-

Ausgänge (koaxial und optisch) für die 
Übertragung auf bis zu 64 separaten Kanälen 
(32 Kanäle über DigiLink Mini-Anschluss)

• Unterstützt Samplerates 44,1, 48, 88,2, 96, 
176,4 und 192 kHz

• Auflösung 24 Bit oder 16 Bit

• Samplerate-Konvertierung (Sample Rate 
Conversion, SRC) an Ein- oder Ausgang

• Anzeigen für Taktgeber und SRC an Vorderseite

• LEDs an der Vorderseite für anliegendes 
Eingangs- und Ausgangssignal

• BNC-Wordclock-I/O zur Synchronisation von 
HD MADI mit externer 1x-Wordclock

• BNC-Loop-Sync-I/O zur Synchronisation von 
HD MADI mit weiteren Avid HD-Audio-
Interfaces und -Peripheriegeräten (z. B. HD I/O, 
HD OMNI oder SYNC HD)

• Eigener BNC-Wordclock-Eingang und XLR-
AES/EBU-Eingang (nur Clock-Eingang) zur 
Synchronisation mit externen MADI-Geräten (bei 
Samplerate-Konvertierung für den Ausgang)

• Unterstützung von Taktgebern der folgenden 
Formate: intern, Loop Sync, Wordclock, 
AES/EBU und MADI

• Varispeed-Modi (Standards mit 64 und 56 
Kanälen werden unterstützt.)

Zusätzliche Pro Tools-
Hardwareoptionen
Pro Tools-Softwaresysteme unterstützen auch die 
folgenden Pro Tools-Hardwareoptionen:

• PRE (8-Kanal-Mikrofonvorverstärker)

• Eleven Rack (Gitarrenprozessor)

• Bedienoberflächen:

• Avid-Controller der Artist-Serie 

• C|24

• Command|8

• MIDI-Controller anderer Hersteller (wie 
M-Audio Axiom® Pro oder Mackie HUI)

Zusätzliche Pro Tools 
HD-Hardwareoptionen
Pro Tools HD kann optional durch die 
nachfolgend aufgeführte Avid HD-Hardware 
erweitert werden.

• SYNC HD-Peripheriegeräte zur 
Synchronisation (nur Avid HDX- und 
HD Native-Systeme):

• PRE (8-Kanal-Mikrofonvorverstärker)

• Eleven Rack (Gitarrenprozessor)

• Bedienoberflächen:

• Avid-Controller der Artist-Serie 

• Avid-Controller der Pro-Serie

• C|24

• Command|8

• D-Command

• D-Control

• Surround Panner-Option

• MIDI-Controller anderer Hersteller (wie 
M-Audio Axiom® Pro oder Mackie HUI)

Weitere Informationen hierzu finden Sie im HD 
MADI-Handbuch.
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Pro Tools-Softwareoptionen
Avid HDX mit HEAT

HEAT (Harmonically Enhanced Algorithm 
Technology) ist eine kostenpflichtige Software-
option, die Avid HDX-Systemen ein „analoges 
Feeling“ verleiht. Weitere Informationen finden 
Sie unter Kapitel 42: „HEAT“.

Avid HDX- und HD Native-Systeme 
mit MachineControl

Die MachineControl™-Softwareoption für 
Pro Tools HD wird von Avid HDX- und 
HD Native-Systemen unterstützt. MachineControl 
ist eine kostenpflichtige Softwareoption für 
Pro Tools HD, die die serielle Kommunikation mit 
9-Pin-kompatiblen Sony®-Synchronizern sowie 
Video- oder Audiogeräten ermöglicht. Weitere 
Informationen können Sie dem MachineControl-
Handbuch entnehmen.

Pro Tools mit VENUE Link

Für Pro Tools-Systeme, die via Ethernet 
mit VENUE-Systemen verbunden werden, 
bietet VENUE Link Systemintegration und 
Interoperabilität zwischen Pro Tools- und 
VENUE-Systemen.

Suchen nach 
Software-Updates
Pro Tools kann automatisch oder manuell nach 
Updates für Pro Tools-Anwendungen und -Plug-
Ins suchen. Für die Suche nach Software-Updates 
benötigen Sie eine Internetverbindung. Etwa alle 
zwei Wochen sucht Pro Tools online nach 
verfügbaren Anwendungs- und Plug-In-Updates.

Stehen Updates für Pro Tools oder für Plug-Ins zur 
Verfügung, gibt Pro Tools die verfügbaren 
Updates sowie deren Bedeutung für Ihr System an. 
Sie können dann auf der Avid-Website nach den 
geeigneten Updates für Ihr Pro Tools-System 
suchen, sie herunterladen und installieren.

So suchen Sie manuell nach Updates:

1 Starten Sie Pro Tools.

2 Wählen Sie Help > Check For Updates.

3 Sie haben folgende Möglichkeiten:

• Wenn keine Updates verfügbar sind, klicken 
Sie auf OK.

• Sind Updates verfügbar, führen Sie einen der 
folgenden Schritte aus:

• Klicken Sie auf Details, um den Webbrowser 
zu starten und die zum Download verfügbaren 
Updates anzuzeigen.

• Klicken Sie auf Not Now, wenn Sie die 
Updates erst später prüfen und 
herunterladen möchten.

So deaktivieren Sie die automatische Suche 
nach Updates:

 Aktivieren Sie im Software Update-
Dialogfeld die Option Do Not Check For 
Updates Automatically.

So aktivieren Sie die automatische Suche 
nach Updates:

1 Wählen Sie Help > Check For Updates. 

2 Deaktivieren Sie im Software Update-
Dialogfeld die Option Do Not Check For 

Updates Automatically.
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Kapitel 6: System-Setup

Sie können die Systemkonfiguration überprüfen und 
ändern, damit sie Ihren Anforderungen entspricht.

Starten bzw. Herunterfahren 
des Systems
Damit die einzelnen Komponenten Ihres 
Pro Tools-Systems ordnungsgemäß miteinander 
kommunizieren können, müssen sie in einer 
bestimmten Reihenfolge gestartet werden.

Starten Sie das Pro Tools-System in 
dieser Reihenfolge:

1 Vergewissern Sie sich, dass sämtliche 
Geräte (einschließlich des Computers) 
ausgeschaltet sind.

2 Reduzieren Sie die Lautstärke aller 
Ausgabegeräte des Systems. 

3 Schalten Sie bei Systemen mit 
Erweiterungschassis zuerst dieses Chassis ein.

4 Schalten Sie alle externen Festplatten ein. 
Warten Sie ca. 10 Sekunden, bis diese ihre 
Betriebsgeschwindigkeit erreicht haben.

5 Schalten Sie Bedienoberflächen (wie D-
Command oder Avid Artist Control) ein.

6 Schalten Sie MIDI-Schnittstellen, MIDI-Geräte 
und/oder Synchronisationseinheiten ein.

7 Führen Sie, abhängig von Ihrem Pro Tools-
System, einen der folgenden Schritte aus:

• Avid HDX- und HD Native-Systeme: 
Reduzieren Sie die Lautstärke aller 
Ausgabegeräte und schalten Sie dann Ihre 
Audio-Interfaces (wie etwa HD OMNI) ein. 
Warten Sie mindestens 15 Sekunden, bis die 
Systemhardware initialisiert ist.

• Pro Tools-Systeme mit Hardware, die eine 
externe Stromversorgung benötigt (wie etwa 
003): Schalten Sie die Hardware bei verringerter 
Lautstärkeeinstellung der Ausgabegeräte ein.

8 Schalten Sie Ihren Computer ein. 

9 Starten Sie Pro Tools bzw. Audio- oder 
MIDI-Anwendungen anderer Hersteller. 

Fahren Sie das Pro Tools-System in der folgenden 
Reihenfolge herunter:

1 Beenden Sie Pro Tools und alle anderen 
laufenden Anwendungen. 

2 Schalten Sie die Ausgabegeräte des Systems 
aus oder reduzieren Sie die Lautstärke auf 
das Minimum. 

3 Schalten Sie Ihren Computer aus.

Um Pro Tools zu beenden, wählen Sie 
„File > Exit“ (Windows) bzw. 
„Pro Tools > Quit“ (Mac).
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4 Führen Sie je Pro Tools-System einen der 
folgenden Schritte aus:

• Avid HDX- und HD Native-Systeme: Schalten 
Sie die Pro Tools-Audio-Interfaces aus.

• Pro Tools-Systeme mit Hardware, die eine 
externe Stromversorgung benötigt (wie etwa 
003): Schalten Sie die Hardware aus.

5 Schalten Sie bei Systemen mit 
Erweiterungschassis zuerst dieses Chassis aus.

6 Schalten Sie MIDI-Interfaces, MIDI-Geräte 
und Synchronisationsgeräte aus.

7 Schalten Sie Bedienoberflächen (wie etwa 
D-Command) oder Hardware-Bedienober-
flächen (wie etwa Command|8) aus.

8 Schalten Sie die externen Festplatten aus.

Prüfen eines Pro Tools|HDX- 
oder Pro Tools|HD Native-
Systems mit DigiTest
Vor der Verwendung von Pro Tools sollten Sie mit 
dem DigiTest-Diagnoseprogramm überprüfen, 
ob alle im System vorhandenen Avid HDX-Karten 
erkannt werden, in der richtigen Reihenfolge 
installiert sind und ordnungsgemäße Verbin-
dungen aufweisen. Mit DigiTest können Sie auch 
Ihre HD Native-PCIe-Karte oder Ihr Thunderbolt-
Interface validieren. Weitere Informationen hierzu 
finden Sie im Avid DigiTest-Handbuch.

Konfigurieren der Pro Tools-
Systemeinstellungen
Mit Pro Tools können Sie die Leistung Ihres Systems 
anpassen, indem Sie die Systemeinstellungen 
ändern, die sich auf die Verarbeitungs-, Wiedergabe- 
und Aufnahmekapazität auswirken. Diese System-
einstellungen sind im Playback Engine-Dialogfeld 
(Setup > Playback Engine) verfügbar.

In den meisten Fällen gewährleisten die 
Standardeinstellungen eine optimale System-
leistung. Es ist jedoch durchaus möglich, 
dass Sie die Einstellungen für längere bzw. 
verarbeitungsintensive Pro Tools-Sessions 
ändern möchten. 

Playback Engine für ein Pro Tools|HDX-System

Playback Engine für Pro Tools mit Mbox 
(3. Generation)
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Playback Engine
In Pro Tools können Sie im Playback Engine-
Dialogfeld die Audio-Engine auswählen, die für Ihre 
Audio-Interfaces verwendet werden soll. Welche 
Optionen zur Verfügung stehen, hängt davon ab, 
welche Interfaces angeschlossen und für welche 
Interfaces kompatible Treiber installiert sind. 

Das Ändern der Playback Engine-Einstellung 
kann nützlich sein, wenn Sie an Ihrem Computer 
mehrere Audio-Interfaces mit verschiedenen 
Routing-Konfigurationen in Ihrem Studio anges-
chlossen haben oder wenn Sie eine Session mit 
einem bestimmten Interface auf einem anderen 
System vorbereiten möchten (etwa wenn Sie eine 
auf Ihrem Avid HDX-System erstellte Session für 
die integrierten Audiofunktionen auf Ihrem Mac-
Laptop vorbereiten).

So wählen Sie die Audio Engine zur Verwendung 
in Pro Tools aus:

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie aus dem Playback Engine-
Dropdown Ihr Audio-Interface:

• Avid HDX- und HD Native-Systeme: 
Verwenden Sie die Standardeinstellung 
HDXbzw. HD Native.

• Unterstützte Avid-Interfaces (wie etwa Mbox 
Pro): Wenn Sie den Namen des entsprechenden 
Interface auswählen, wird für Pro Tools die Avid 
Audio Engine verwendet. 

• Mit Core Audio (Mac) bzw. ASIO (Windows) 
kompatible Audio-Interfaces anderer Hersteller: 
Wählen Sie den Namen des entsprechenden 
Audio-Interface aus.

• Wenn Sie auf Mac-Systemen die integrierten 
Audiofunktionen verwenden: Wählen Sie eine 
der verfügbaren integrierten Wiedergabeoptionen 
oder wählen Sie Pro Tools Aggregate I/O für 
gleichzeitige Ein- und Ausgänge über die 
integrierten I/O-Hardwareoptionen.

3 Klicken Sie auf OK.

Wenn die Engine bei geöffneter Pro Tools-Session 
gewechselt wird, schließt Pro Tools die Session 
und startet sie erneut, um die neue Engine 
zu initialisieren.

Wenn Sie Engines auf Avid HDX-Systemen 
wechseln, müssen Sie Pro Tools beenden und 
erneut starten, damit die neue Einstellung 
wirksam wird.

Pro Tools Aggregate I/O
(Nur Mac)

Auf Mac-Systemen mit Core Audio können Sie 
Pro Tools für die im Mac integrierten Audioein- 
und -ausgänge verwenden, indem Sie entweder 
verfügbare integrierte Ein- und Ausgänge 
auswählen oder die Option Pro Tools 

Aggregate I/O aktivieren und eine Kombination 
aus integrierten Ein- und Ausgängen gleichzeitig 
benutzen (für Aufnahme und Monitoring). 

Bei einem Engine-Wechsel kann es auf 
jedem Pro Tools-System sein, dass Sie die 
I/O-Einstellungen auf die 
Standardeinstellungen zurücksetzen 
müssen, um sie an das ausgewählte Audio-
Interface anzupassen.

Aktivieren von „Pro Tools Aggregate I/O“ im Playback 
Engine-Dialogfeld (nur Mac)
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Sie können die Ein- und Ausgangsoptionen für 
Pro Tools Aggregate I/O im Mac-Audio-Setup 
konfigurieren, das über das Pro Tools-Hardware-
Setup aufgerufen werden kann.

Hardware-Puffergröße
Die Hardware-Puffergröße (H/W Buffer Size) in 
der Playback Engine bestimmt die Größe des 
Puffers für hostbasierte Processing-Aufgaben wie 
die Verarbeitung von hostbasierten oder „nativen“ 
Plug-Ins.

• Eine geringere Hardware-Puffergröße ist 
nützlich, um die Abhörlatenz in bestimmten 
Aufnahmesituationen zu verringern oder um 
die Leistung Ihres Systems zu verbessern.

• Bei allen Pro Tools-Systemen führen 
niedrigere Einstellungen zu einer Reduzierung 
der MIDI-Audio-Latenz (etwa wenn Sie ein 
virtuelles Instrument live abspielen und die 
Ausgabe des Instruments abhören). Durch 
niedrigere Einstelllungen kann auch die 
Bildschirmanzeige beschleunigt und die 
Genauigkeit von Plug-In- und Stummschal-
tungsdaten verbessert werden.

• Bei hostbasierten Pro Tools-Systemen führen 
niedrigere Einstellungen zu einer Reduzierung 
der gesamten Abhörlatenz vom Eingang zum 
Ausgang auf sämtlichen scharfgeschalteten 
Spuren oder Auxiliary-Eingangs-Spuren 
mit Live-Signalen.

• Bei Avid HDX-Systemen verringern 
niedrigere Einstellungen die Abhörlatenz 
auf Spuren mit einem oder mehreren Native-
Plug-Ins. Bei Systemen ohne ein Zeitstempel-
unterstützendes MIDI-Interface können 
niedrigere Einstellungen jedoch auch die 
Genauigkeit des MIDI-Spur-Timings erhöhen. 
Außerdem verbessert sich das MIDI-Spur-
Timing durch niedrigere Einstellungen auf 
Spuren, für die virtuelle MIDI-Instrumente 
ohne Zeitstempelunterstützung 
verwendet werden.

• Höhere Einstellungen beim Hardware-Puffer 
sind für Sessions geeignet, bei denen mehrere 
Native-Plug-Ins zur Wiedergabe verwendet 
werden. Diese Einstellungen ermöglichen eine 
bessere Audioverarbeitung. Durch höhere 
Einstellungen lassen sich außerdem Fehler bei 
Geräten verringern, die eine höhere 
Puffergröße erfordern.

So stellen Sie die Hardware-Puffergröße ein:

1 Wählen Sie Setup > Playback Engine. 

2 Wählen Sie im H/W Buffer Size-Popup-Menü 
die gewünschte Audio-Puffergröße in Samples. 

3 Klicken Sie auf OK. 

Host Engine
Die Host Engine-Einstellungen bieten Optionen für 
die Fehlerunterdrückung während der Wiedergabe 
und Aufnahme sowie eine Option zur Verwendung 
dynamischer Plug-In-Verarbeitung.

Wenn Sie für Pro Tools gleichzeitig Eingänge 
(Aufnahme) und Ausgänge (Wiedergabe und 
Monitoring) sowie die im Mac integrierten 
Audiooptionen nutzen möchten, aktivieren 
Sie die Option „Pro Tools Aggregate I/O“. 
Falls Sie Audiomaterial lediglich zum 
Editieren und Mischen wiedergeben müssen, 
wählen Sie unter den integrierten 
Audioausgangsoptionen die geeignete aus.
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Ignore Errors During 
Playback/Recording

Die Ignore Errors During Playback/Record-Option 
legt fest, wie Pro Tools auf Fehleranzeigen der Avid 
Audio Engine (AAE) während der Wiedergabe und 
Aufnahme reagiert. Dies ist hilfreich, wenn Sie mit 
Instrumenten-Plug-Ins arbeiten, wo Klick- und 
Knackgeräusche im Audiosignal weniger von 
Bedeutung sind, während Sie an der Komposition 
und am Arrangement arbeiten. Bevor Sie am 
endgültigen Mix arbeiten, sollten Sie diese Option 
deaktivieren. Beachten Sie folgende Richtlinien bei 
der Entscheidung, die Fehlerunterdrückung zu 
aktivieren oder zu deaktivieren:

• Aktivieren Sie die Fehlerunterdrückung nur, 
wenn Ihr kreatives Arbeiten durch häufige 
Fehler unterbrochen wird. Wenn die 
Fehlerun-terdrückung aktiviert ist, kann dies 
die Audio-qualität beeinträchtigen. Wenn Sie 
jedoch mit Instrumenten-Plug-Ins arbeiten, 
nehmen Sie möglicherweise eine etwas 
geringere Audio-qualität gern in Kauf, 
um häufige Unterbre-chungen bei der 
Wiedergabe zu vermeiden.

• Deaktivieren Sie die Fehlerunterdrückung, 
wenn höchste Audioqualität erforderlich ist 
(etwa bei einer endgültigen Mischung).

So aktivieren Sie die Fehlerunterdrückung:

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie Ignore Errors During 

Playback/Record.

3 Klicken Sie auf OK.

Wenn die Ignore Errors During Playback/Record-
Option aktiviert ist, kann es aufgrund von zu vielen 
aktiven prozessorlastigen Native-Plug-Ins in der 
Session (Eleven Free oder verschiedene Virtual 
Instrument-Plug-Ins) zu unsauber verzerrtem 
Audiomaterial kommen. Entfernen oder deaktivieren 
Sie nicht benötigte Native-Plug-Ins, wenn dieses 
Problem auftritt. Sie können ebenfalls alle Spuren mit 
virtuellen Instrumenten isolieren oder über einen Bus 
aufzeichnen und die entsprechenden Quellspuren 
anschließend deaktivieren, um Prozessorressourcen 
zu entlasten.

Minimize Additional I/O Latency
(Nur hostbasierte Pro Tools-Systeme)

– nach der Aktivierung der Minimize Additional I/O 

Latency-Option wird eine eventuelle zusätzliche 
Latenz aufgrund des Ignorierens von Fehlern 
während der Wiedergabe und Aufnahme auf 
128 Samples reduziert. Das Ignorieren von Fehlern 
erfordert auf manchen Systemen einen zusätzlichen 
Puffer von mindestens 128 Samples. Ist diese 
Option deaktiviert, beträgt die Puffergröße die 
Hälfte der H/W Buffer Size oder mindestens 
128 Samples (je nachdem, welches der höhere Wert 
ist). Bei älteren, langsameren Computern sollten Sie 
diese Option deaktivieren, da sie sich sonst 
nachteilig auf die Leistung auswirkt.

Diese Option ist nur verfügbar, wenn die Ignore 

Errors During Playback/Record-Option aktiviert ist 
und das von Ihnen eingesetzte Pro Tools-System 
einen größeren Pufferspeicher für die Fehlerunter-
drückung erfordert:

• Windows:

• Mbox Pro und Mbox 2 Pro

• Mac:

• Geräte der 003-Produktfamilie

• Eleven Rack

• Geräte der Mbox-Produktfamilie

• Pro Tools Aggregate I/O
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Dynamic Plug-In Processing

Nach der Aktivierung maximiert die Dynamic 
Plug-In Processing-Option die Plug-Ins je nach 
Bedarf durch dynamische Neuzuweisung 
hostbasierter Prozessorressourcen. Das heißt, dass 
Plug-Ins nur dann Prozessorzyklen verwenden, 
wenn sie tatsächlich Audio verarbeiten.

So aktivieren Sie die dynamische 
Plug-In-Verarbeitung

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie Dynamic Plug-In Processing.

3 Klicken Sie auf OK.

Number of Voices
(Nur Avid HDX-Systeme)

Bei Avid HDX-Systemen bestimmt die Number of 
Voices-Einstellung in der Playback Engine die 
Anzahl der verfügbaren Voices und deren 
Zuweisung an die DSPs im System.

Eine Änderung der Anzahl der Voices wirkt sich 
auf die DSP-Auslastung, die Gesamtanzahl der 
spielbaren Spuren und die Gesamtleistung des 
Systems aus. 

Abhängig von der Samplerate der Session und der 
Anzahl der Avid HDX-Karten in Ihrem System 
stehen Ihnen bei der Voice-Anzahl verschiedene 
Möglichkeiten zur Auswahl. Informationen zu 
Voice-Limits auf verschiedenen Avid HDX-
Systemen finden Sie unter „Wiedergabe-, 
Aufnahme- und Voice-Limits bei Pro Tools HD“ 
auf Seite 45.

So ändern Sie die Voice-Anzahl und die DSPs für 
die Voice-Zuweisung:

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie im Number of Voices-Popup-Menü 
die Anzahl der Voices und die DSPs für die 
Voice-Zuweisung wie folgt aus:

• Wählen Sie die niedrigste Voice-Anzahl, wenn 
Sie neben den Avid HDX-Karten auch PCIe-
Karten mit hoher Bandbreite (etwa Karten zur 
Videoaufnahme) einsetzen. Diese Einstellungen 
belasten die einzelnen DSP-Chips am wenigsten, 
aber es sind dann mehr DSP-Chips für Voices 
und Mischen erforderlich (weniger freie Chips 
für Plug-Ins).

• Wählen Sie eine mittlere Voice-Anzahl, 
wenn Sie Avid HDX-Karten in ein 
Erweiterungschassis eingebaut haben oder 
zusammen mit Ihren Avid HDX-Karten weitere 
PCIe-Karten verwenden. Diese Einstellungen 
bieten normalerweise ein optimales Verhältnis 
zwischen der Anzahl der Chips für Voices und 
der Auslastung der einzelnen Chips.

• Wählen Sie eine höhere Voice-Anzahl, wenn die 
Avid HDX-Karten die einzigen PCIe-Karten in 
Ihrem Computer sind, oder wenn Sie ein 
Erweiterungschassis für eine höhere Spuranzahl 
(z. B. 64 Spuren bei 96 kHz) verwenden und 
mehr Voices pro DSP zuweisen möchten 
(z. B. 16 Voices pro DSP bei 96 kHz). Diese 
Einstellungen verwenden weniger DSP-Chips 
zum Mischen (es bleiben mehr für die Plug-Ins 
verfügbar), belasten aber die einzelnen Chips 
am stärksten.

3 Klicken Sie auf OK. 
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Sample Rate
(Nur Avid HDX)

Die Sample Rate-Einstellung in der Playback 
Engine wird als Standardeinstellung beim Erstellen 
einer neuen Session angezeigt. In einer geöffneten 
Session wird die Samplerate der aktuellen Session 
angezeigt, sie kann jedoch nicht geändert werden. 
Wenn keine Session geöffnet ist, können Sie die 
Standard-Samplerate für neue Sessions festlegen:

Video Engine
Aktivieren Sie die Video Engine-Option, 
um zahlreiche Avid-HD- und -SD-MXF-Video-
formate für Pro Tools-Videospuren ohne 
Transkodierung (einschließlich Avid DNxHD®) 
sowie QuickTime-Video zu importieren, 
zu bearbeiten und wiederzugeben. Mit der Video 
Engine können Sie gleichzeitig das Monitoring 
für Desktopvideo und Video über ein Video-
peripheriegerät (Avid Nitris® DX, Mojo® DX und 
andere von Avid qualifizierte Video-Interfaces 
anderer Hersteller) anzeigen.

So aktivieren Sie die Avid Video Engine für 
Pro Tools:

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie die Video Engine-Option.

3 Klicken Sie auf OK.

Cache-Größe
(Nur Pro Tools HD-Software)

Die Cache Size-Einstellung in der Playback 
Engine bestimmt, wie viel Speicher die AAE beim 
Puffern von Audio-Wiedergabe und -aufnahme 
zuweist. In den meisten Fällen ist die 
Standardeinstellung Normal die optimale Cache 
Size-Einstellung für die meisten Sessions.

In Pro Tools HD können Sie Audiodateien, die in 
Pro Tools-Sessions verwendet werden, in den 
Arbeitsspeicher (RAM) laden und von dort aus 
wiedergeben. Pro Tools priorisiert dabei Dateien, 

die am nächsten zur aktuellen Wiedergabeposition 
liegen. Dadurch sind diese Dateien bereits für 
die Wiedergabe zwischengespeichert. Dies ist 
besonders nützlich bei der Arbeit mit Zentral-
speichersystemen für Medien (beispielsweise mit 
Avid Unity ISIS). 

Um die maximal im Festplattencache verfügbare 
RAM-Größe herauszufinden, fragt Pro Tools den 
im Computer installierten RAM ab und 
subtrahiert 4 GB. 

Wenn Ihr Computer beispielsweise über 12 GB 
RAM verfügt, ist die Gesamtgröße des verfügbaren 
RAM für den Festplattencache 8 GB.

So legen Sie die RAM-Größe für den 
Festplattencache fest:

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie über den Disk Cache-Selektor 
die gewünschte RAM-Größe für 
den Festplattencache.

3 Klicken Sie auf OK.

Konfigurieren von 
MIDI-Einstellungen
Wenn Sie planen, externe MIDI-Geräte 
(etwa Controller, Keyboards, Synthesizer, Drum-
Computer, Sampler, Sequenzer oder Soundmodule) 
gemeinsam mit Pro Tools einzusetzen, sollten Sie 
eventuell Ihr MIDI-Setup mithilfe des Programms 
Audio-MIDI-Konfiguration (Mac) bzw. MIDI-
Studio-Setup (Windows) konfigurieren.

Anhand der „Disk Cache“- und der 
Speicheranzeige im Systemauslastungsfenster 
können Sie bestimmen, ob Sie dem 
Festplattencache für die aktuelle Session mehr 
oder weniger RAM zuweisen sollten. Siehe 
„Systemauslastung“ auf Seite 66.

Weitere Informationen finden Sie unter 
Kapitel 10: „MIDI-Konfiguration“.
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Konfigurieren der Pro Tools-
Hardwareeinstellungen
Mit Pro Tools können Sie in Abhängigkeit von 
Ihrer Systemkonfiguration die Einstellungen 
für Signalrouting, digitales I/O-Format, 
Standard-Samplerate, Taktgeber sowie andere 
hardware-basierte Einstellungen festlegen. 
Diese System-einstellungen sind im Hardware-
Setup (Setup > Hardware) verfügbar.

Auswählen von Audio-Interfaces 
zur Konfiguration
In der Peripherals-Liste im Hardware Setup-
Dialogfeld können Sie ein beliebiges an Ihr 
Pro Tools-System angeschlossenes Audio-Interface 
auswählen, das der im Playback Engine-Dialogfeld 
ausgewählten Current Engine-Einstellung 
zugeordnet ist.

Informationen zum Ändern der Playback Engine-
Einstellung und zur Nutzung bestimmter Audio-
Interfaces oder AAEs (wie etwa HDX, 003, 
ein Core Audio- oder ASIO-Interface eines anderen 
Herstellers oder Pro Tools Aggregate I/O) finden 
Sie unter „Playback Engine“ auf Seite 53.

Beim Einsatz von Avid HD-Audio-Interfaces 
(wie etwa HD OMNI oder HD I/O) können Sie 
für jedes an Ihr System angeschlossene HD-
Peripheriegerät die Einstellungen für Signalrouting, 
das Format der digitalen I/O, die Standard-
Samplerate, Taktgeber sowie andere hardware-
basierte Einstellungen festlegen.

Beim Einsatz von einigen Avid-Audio-Interfaces 
(wie etwa 003) können Sie je nach System-
konfiguration die Einstellungen für Signalrouting, 
Digital-I/O-Format, Standard-Samplerate und 
Taktgeber sowie andere hardwarebasierte 
Einstellungen konfigurieren. 

Bei Verwendung von Audio-Interfaces der Mbox-
Produktfamilie der dritten Generation sowie 
mit Core Audio (Mac) und ASIO (Windows) 
kompatiblen Audio-Interfaces anderer Hersteller 
klicken Sie auf die Launch Control Panel-
Schaltfläche, um das Systemfeld zur Konfiguration 
Ihres jeweiligen Audio-Interface aufzurufen.

Hardware-Setup für HD OMNI, Main-Registerkarte

Hardware-Setup für Mbox 2 (dritte Generation)
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Starten des Bedienfelds oder 
der Setup-Anwendung
(Nur Pro Tools mit Audio-Interfaces aus 
der Mbox-Produktfamilie oder von 
anderen Herstellern)

Über das Bedienfeld oder die Setup-Anwendung 
für Ihr Audio-Interface können Sie je nach Audio-
Interface Einstellungen in den folgenden 
Bereichen ändern:

• Mixer-Einstellungen

• Output-Einstellungen

• Hardware-Einstellungen (einschließlich 
Samplerate, Hardware-Puffergröße und 
Sync-Quelle).

So ändern Sie Systemfeld-Einstellungen:

1 Klicken Sie im Hardware Setup-Dialogfeld 
auf die Launch Control Panel-Schaltfläche 
oder die Launch Setup App-Schaltfläche 
(je nach Audio-Interface).

2 Informationen zum Ändern der Einstellungen 
im Systemfeld oder der Setup-Anwendung 
finden Sie in der Dokumentation, 
die zusammen mit Ihrem Audio-Interface 
ausgeliefert wurde.

3 Schließen Sie das Systemfeld oder die Setup-
Anwendung, nachdem Sie alle gewünschten 
Änderungen vorgenommen haben.

Konfigurieren von Pro Tools 
Aggregate I/O
(Nur Mac)

Auf Mac-Systemen mit Core Audio können Sie 
im Current Engine-Dialogfeld die Pro Tools 

Aggregate I/O-Option auswählen, um die im Mac 
integrierten Audioein- und -ausgänge zu benutzen. 
Sie können die Pro Tools Aggregate I/O-Einstellung 
im Mac Audio-Setup, das vom Pro Tools-Hardware-
Setup aus aufgerufen werden kann, konfigurieren.

So konfigurieren Sie Pro Tools Aggregate 
I/O-Einstellungen:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie in der Peripherals-Liste Pro Tools 

Aggregate I/O oder die als Current Engine im 
Playback Engine ausgewählte integrierte Input- 
oder Output-Option.

3 Klicken Sie auf die Launch Setup 

App-Schaltfläche.

4 Konfigurieren Sie im Mac-Audio-Setup im 
Fenster „Audio Geräte“ die Pro Tools 
Aggregate I/O-Einstellungen.

Beim Erstellen einer neuen Pro Tools-
Session können Sie im New Session-
Dialogfeld eine Auswahl für die 
Samplerate treffen.

Hardware-Setup für Pro Tools Aggregate I/O (nur Mac)

Das Pro Tools Aggregate I/O-Gerät ist 
ausschließlich für die Verwendung mit 
der integrierten Audiofunktion auf Mac-
Computern konzipiert. Verwenden 
Sie für bestmögliche Leistung 
die Standardeinstellungen.
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Konfigurieren der Samplerate-
Standardeinstellung im 
Hardware Setup
Die Sample Rate-Einstellung im Hardware Setup-
Dialog wird als Standardeinstellung beim Erstellen 
einer neuen Session angezeigt. Diese Einstellung ist 
nur verfügbar, wenn keine Sessions geöffnet sind. 
Andernfalls wird die Samplerate der aktuellen 
Session angezeigt, sie kann jedoch nicht 
geändert werden.

Bei Avid HDX- und HD Native-Hardware kann 
die Standardeinstellung für die Samplerate im 
Hardware-Setup oder in der Playback Engine 
geändert werden.

Bei anderen Pro Tools-Systemen kann die 
Samplerate-Standardeinstellung nur im Hardware-
Setup bzw. bei Audio-Interfaces von anderen 
Herstellern nur über das jeweilige Systemfeld 
geändert werden.

So ändern Sie die Samplerate-Standardeinstellung 
im Hardware-Setup:

1 Wählen Sie Setup > Hardware Setup. 

2 Wählen Sie im Sample Rate-Popup-Menü die 
gewünschte Samplerate aus.

3 Klicken Sie auf OK.

Konfigurieren des Taktgebers
Im Hardware-Setup von Pro Tools können Sie 
die Clock Source (den Taktgeber) für das 
System auswählen.

Internal – wenn Sie ein analoges Signal direkt in 
Pro Tools aufnehmen, verwenden Sie normaler-
weise den internen Pro Tools-Taktgeber (Internal). 

External – wenn Sie Material von einem externen 
Digitalgerät in Pro Tools übertragen oder ein 
gemeinsames studioweites Taktsignal verwenden, 
synchronisieren Sie Pro Tools mit diesem digitalen 
Gerät oder gemeinsamen Signal. 

Je nachdem, mit welchem Audio-Interface Sie 
arbeiten, gibt es folgende Optionen für den 
externen Taktgeber: AES/EBU [Encl], S/PDIF, 
Optical [Encl], AES/EBU 1–8, TDIF, ADAT und 
Word Clock. Weitere Informationen hierzu finden 
Sie im Handbuch zu Ihrem Audio-Interface.

So wählen Sie die Taktquelle aus:

1 Wählen Sie Setup > Hardware. 

2 Wählen Sie aus dem Clock Source-Popup-
Menü den Taktgeber.

3 Klicken Sie auf OK. 

Bei Avid HDX- und HD Native-Hardware 
kann sich die Samplerate-Einstellung auf 
die Anzahl verfügbarer Voices auswirken.

Beim Erstellen einer neuen Pro Tools-Session 
können Sie im New Session-Dialogfeld eine 
Auswahl für die Samplerate treffen.

Änderungen an der Taktgebereinstellung, 
die Sie im Session Setup-Fenster vornehmen, 
werden in das Hardware Setup-
Fenster übernommen.

Zur Synchronisation muss das digitale 
Eingabegerät eingeschaltet und mit 
Pro Tools verbunden sein. Wenn Ihr 
Eingabegerät nicht eingeschaltet ist, 
behalten Sie für „Clock Source“ die 
Internal-Einstellung bei.
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Konfigurieren von Digitalformat 
und Hardwarerouting
Das Hardware-Setup umfasst zusätzliche 
Einstellungen für die Konfiguration des digitalen 
Formats und des Hardwareroutings für die Audio-
Interfaces Ihres Systems.

Einen Überblick über die Konfiguration eines 
Avid HDX- oder HD Native-Systems mit einem 
oder mehreren Avid HD-Interfaces finden Sie 
unter „Konfigurieren der Avid HDX- und 
HD Native-Hardwareeinstellungen“ auf Seite 61.

Auswählen der 
Fußschaltersteuerung
(Nur 003)

Der Fußschalter-Anschluss an Interfaces der 003-
Produktfamilie ermöglicht den Einsatz eines Fuß-
schalters zum Starten und Anhalten der Wiedergabe 
oder für Punch-In/-Out-Vorgänge zur Aufzeichnung. 
QuickPunch-Audiofunktionen und Punch-In und 
Punch-Out für MIDI-Aufzeichnungen 
werden unterstützt. 

Record Punch In/Out – wählen Sie diese 
Option aus, um für das Punch-In/-Out 
während der Aufzeichnung einen am Interface der 
003-Produktfamilie angeschlossenen Fußschalter 
zu verwenden.

Playback Start/Stop – wählen Sie diese Option 
aus, um zum Starten und Stoppen der Wiedergabe 
einen am Interface der 003-Produktfamilie 
angeschlossenen Fußschalter zu verwenden.

Konfigurieren der Avid HDX- 
und HD Native-
Hardwareeinstellungen
Bei Avid HDX- und HD Native-Systemen 
konfigurieren Sie Hardwareeinstellungen für jedes 
am System angeschlossene Audio-Interface. Siehe 
Kapitel 5: „Pro Tools-Systeme“. 

Avid HDX- und HD Native-Systeme können 
ein HD I/O-, HD OMNI- oder HD MADI-Audio-
Interface haben, die an HDX-Karten oder HD 
Native-Systeme angeschlossen sind. Mit einem 
HD I/O und HD OMNI können außerdem über 
den Erweiterungsanschluss weitere Interfaces 
verbunden sein.

Identifizieren von 
Audio-Interfaces
Wenn mehrere Audio-Interfaces des gleichen Typs 
an das System angeschlossen sind, sollten Sie vor 
dem Anschließen von Audiogeräten zunächst die 
Identität der Audio-Interfaces feststellen. Dadurch 
wird sichergestellt, dass Sie beim Festlegen der Ein- 
und Ausgänge im Hardware-Setup das richtige 
Interface aus der Peripherals-Liste auswählen. 

So ermitteln Sie IDs von Audio-Interfaces 
im System:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie aus der Peripherals-Liste ein an das 
System angeschlossenes Audio-Interface.

3 Vergewissern Sie sich, dass die Main-
Registerkarte ausgewählt ist.

Informationen zur Konfiguration spezifischer 
Hardwareeinstellungen für andere Pro Tools-
Interfaces oder Audio-Interfaces von anderen 
Herstellern finden Sie in der Dokumentation, 
die zusammen mit dem Audio-Interface 
ausgeliefert wurde.

Mit den Pfeiltasten nach oben und unten 
können Sie im Hardware-Setup in der 
Peripherals-Liste die einzelnen 
Peripheriegeräte durchgehen.
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4 Wählen Sie im Hardware-Setup unten links die 
Identify-Option aus. Dadurch leuchten alle 
LEDs an der Vorderseite des ausgewählten 
Audio-Interface auf. 

5 Notieren Sie, welches Interface in der 
Studiokonfiguration dem ermittelten 
Interface entspricht. 

6 Führen Sie die oben beschriebenen Schritte 
für die übrigen Audio-Interfaces in der 
Konfiguration aus.

Konfigurieren von Avid HD-
Audio-Interfaces
HD OMNI unterstützt bis zu acht Anschlüsse 
gleichzeitig in mehreren I/O-Formaten (darunter 
analog, AES/EBU, ADAT Optical und S/PDIF). 

Die HD I/O-Audio-Interfaces unterstützen 16 Ein- 
und Ausgangskanäle gleichzeitig in mehreren I/O-
Formaten (darunter analog, AES/EBU, ADAT 
Optical, S/PDIF und TDIF). HD MADI unterstützt 
bis zu 64 MADI-I/O-Kanäle.

Auf der Main-Registerkarte im Hardware-Setup 
können Sie festlegen, welche physikalischen Ein- 
und Ausgänge Ihres Audio-Interface auf die 
verfügbaren Eingänge und Ausgänge von 
Pro Tools geroutet werden. Dieses Fenster dient 
als Patchbay, mit der Sie jeden beliebigen Eingang 
bzw. Ausgang der Audio-Interfaces auf Kanalzu-
weisungen des Pro Tools-Mixers routen können.

Zum Konfigurieren weiterer Einstellungen 
der einzelnen Audio-Interfaces (etwa des 
Betriebspegels) stehen zusätzliche Registerkarten 
zur Verfügung.

So konfigurieren Sie Avid HD-Audio-Interfaces:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie in der Peripherals-Liste das Audio-
Interface, das an die erste Karte in Ihrem System 
angeschlossen ist. Das ist in der Regel das erste 
Interface der Liste.

3 Klicken Sie auf die Main-Registerkarte.

4 Wählen Sie im Clock Source-Popup-Menü den 
geeigneten Taktgeber für das Interface.

In den meisten Fällen wird Internal verwendet. 
Die anderen Auswahlmöglichkeiten dienen zur 
Taktung von Pro Tools über externe Taktgeber. 
Je nachdem, mit welchem Audio-Interface Sie 
arbeiten, können folgende Optionen für den 
externen Taktgeber angegeben sein: AES/EBU 

[Encl], S/PDIF, Optical [Encl], AES/EBU 1–8, TDIF, 

ADAT und Word Clock (optionale Wordclock-
Raten stehen bei höheren Samplerates 
zur Verfügung).

5 Wenn Sie die Ausgangssignale des Taktgebers 
an andere Geräte senden möchten, die mit dem 
Audio-Interface verbunden sind, wählen Sie im 
Ext. Clock Output-Popup-Menü den 
gewünschten Ausgang. 

Hardware-Setup für HD I/O, Main-Registerkarte

Drücken Sie Befehl + Linkspfeil oder 
Rechtspfeil (Mac) bzw. Strg + Nach Links 
oder Nach Rechts (Windows), um durch die 
Registerkarten im Hardware-Setup 
zu navigieren.
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6 Wählen Sie unter Digital Format den aktiven 
digitalen I/O-Anschluss an Ihrem Audio-
Interface. Je nachdem, welche Interfaces in 
Ihrem System vorhanden sind, können Sie aus 
AES/EBU, S/PDIF und Optical (S/PDIF) wählen. 
Mit Optical (S/PDIF) wird der Optical I/O-Port 
(der per Vorgabe auf acht ADAT Optical-I/O-
Kanäle eingestellt ist) auf zwei S/PDIF Optical 
I/O-Kanäle zurückgesetzt.

7 Um die S/PDIF-Kompatibilität mit Tascam 
DA-30 DAT-Rekordern herzustellen, wählen 
Sie unter „S/PDIF Format“ die Tascam-Option.

8 Wählen Sie aus den Input- und Output-Kanal-
Popup-Menüs die physikalischen Anschlüsse 
(etwa Analog 1–2 oder Optical 1–2), die auf 
die entsprechenden, auf der linken Seite der 
Main-Registerkarte aufgelisteten Eingangs- 
und Ausgangskanäle von Pro Tools 
(etwa Ch 1–2, 3–4) geroutet werden sollen.

Eingänge und Ausgänge eines ähnlichen Formats 
werden in den Input bzw. Output-Kanal-Popup-
Menüs unterschiedlich bezeichnet. Beispiel: Die 
AES/EBU-Ein- und Ausgänge im HD I/O-
Gehäuse werden als AES/EBU [Encl] aufgelistet, 
während AES/EBU-Ein- und Ausgänge auf einer 
werkseitig installierten HD I/O Digital-Karte 
(in Paaren) als AES/EBU 1–2, AES/EBU 3–4, 

AES/EBU 5–6 und AES/EBU 7–8 aufgelistet 
werden. Bei HD I/Os, die mit einer zweiten 
Digital I/O-Karte ausgestattet sind, werden die 
zusätzlichen AES/EBU-Anschlüsse auf der 
optionalen Karte als AES/EBU 9–10, AES/EBU 

11–12, AES/EBU 13–14 und AES/EBU 

15–16 aufgelistet.

9 Konfigurieren Sie spezifische Einstellungen für 
Ihr Audio-Interface:

• „Konfigurieren von HD I/O-Einstellungen“ auf 
Seite 64.

• „Konfigurieren von HD I/O-Einstellungen“ auf 
Seite 65.

• „Konfigurieren von HD MADI-Einstellungen“ 
auf Seite 65.

10 Zur Konfiguration weiterer Audio-Interfaces 
wählen Sie diese in der Peripherals-Liste 
aus und wiederholen Sie die oben 
beschriebenen Schritte.

Weitere Informationen zur Konfiguration und 
zu Einschränkungen finden Sie im Handbuch 
des Audio-Interface.
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Konfigurieren von 
HD I/O-Einstellungen

So konfigurieren Sie HD OMNI in Pro Tools:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie in der Peripherals-Liste das 
HD OMNI-Audio-Interface.

3 Klicken Sie auf die Monitor-Registerkarte und 
konfigurieren Sie die Optionen. Wenn Sie mit 
HD OMNI arbeiten, müssen Sie die Monitor-
Registerkarte immer zuerst konfigurieren.

4 Klicken Sie auf die Main-Registerkarte und 
konfigurieren Sie die Optionen.

5 Klicken Sie auf die Analog In-Registerkarte und 
legen Sie die gewünschten Optionen fest.

6 Klicken Sie auf die Analog Out-Registerkarte 
und legen Sie die gewünschten Optionen fest.

7 Klicken Sie auf die Mixer-Registerkarte und 
konfigurieren Sie die Optionen.

8 Klicken Sie abschließend auf OK.

Weitere Informationen zur 
Konfiguration von HD OMNI finden 
Sie im HD OMNI-Handbuch.

Hardware-Setup von HD OMNI, Monitor-Registerkarte

Hardware-Setup von HD OMNI, Main-Registerkarte

Hardware-Setup von HD OMNI, Analog 
In-Registerkarte

Hardware-Setup von HD OMNI, Analog 
Out-Registerkarte

Hardware-Setup von HD OMNI, Mixer-Registerkarte
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Konfigurieren von 
HD I/O-Einstellungen

So konfigurieren Sie die Einstellungen für HD I/O:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie in der Peripherals-Liste das 
HD I/O-Audio-Interface.

3 Klicken Sie auf die Main-Registerkarte und 
konfigurieren Sie die Optionen.

4 Wenn Sie zumindest eine HD I/O-AD-Karte 
haben, klicken Sie auf die Analog In-Registerkarte 
und konfigurieren Sie die Optionen. Wenn Sie 
zwei HD I/O-AD-Karten haben, heißt diese 
Registerkarte Analog In 1–8.

5 Wenn Sie zwei HD I/O-AD-Karten haben, 
klicken Sie auf die Analog In 9–16-Registerkarte 
und konfigurieren Sie die Optionen.

6 Wenn Sie zumindest eine HD I/O-Digital-Karte 
haben, klicken Sie auf die Digital-Registerkarte 
und konfigurieren Sie die Optionen.

7 Wenn Sie zwei HD I/O Digital-Karten haben, 
klicken Sie auf die zweite Digital-Registerkarte 
und konfigurieren Sie die Optionen.

8 Klicken Sie abschließend auf OK.

Konfigurieren von HD MADI-
Einstellungen

So konfigurieren Sie die Einstellungen für 
HD MADI:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie in der Peripherals-Liste entweder 
„HD MADI Port 1“ oder „HD MADI Port 2“ 
und konfigurieren Sie die Optionen.

3 Klicken Sie abschließend auf OK.

Weitere Informationen zum Konfigurieren 
von HD I/O finden Sie im HD I/O-Handbuch.

Hardware-Setup von HD I/O, Main-Registerkarte

Hardware-Setup von HD I/O, Analog In-Registerkarte

Weitere Informationen zur 
Konfiguration von HD MADI finden 
Sie im HD MADI-Handbuch.

HD MADI – Hardware-Setup

Die Einstellungen für HD MADI Port 1 
und HD MADI Port 2 sind gekoppelt. 
Änderungen wirken sich ohne Rücksicht 
darauf, welche der Optionen in der 
Peripherals-Liste ausgewählt ist, global aus.
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Systemauslastung
Anzeigen im System Usage-Fenster geben an, 
wie viel Prozessorleistung Ihres Systems für 
die Audioverarbeitung und das Schreiben und 
Abspielen von Automation genutzt wird.

Nähern sich diese Pegelanzeigen den Maximal-
werten, kann die Hostverarbeitung und Aufnahme 
oder Wiedergabe von Automations-daten beein-
trächtigt werden. Wenn die Prozessor- oder PCI-
Aktivität hoch ist, können Systemfehler auftreten. 
Bei hoher Festplattenaktivität tendiert Pro Tools 
in Phasen besonders hoher Aktivität (etwa bei 
Verwendung des Bounce to Disk-Befehls) dazu, 
die Wiedergabe einiger Automationsdaten 
auszulassen. 

CPU-Anzeigen
Die CPU Total-Anzeige gibt einen vollständigen 
Überblick über die Verarbeitung von Elastic 
Audio, Clip-Gain sowie Native-Plug-Ins 
und Mixer.

Die einzelnen CPU-Anzeigen bieten einen 
allgemeinen Überblick, wie viel von jedem 
Prozessor Ihres Computers von Pro Tools in 
Anspruch genommen wird.

Aktivitäts-Anzeigen
Der Aktivitätsbereich des „System Usage“-
Fensters verfügt über Anzeigen für die Speicher-
platznutzung und Speicherauslastung.

Datenträgeranzeige

Wie in früheren Versionen von Pro Tools zeigt die 
Disk-Anzeige, in welchem Ausmaß die Festplatten 
genutzt wird.

Datenträgercache-Anzeige
(Nur Pro Tools HD-Software)

Pro Tools HD-Software verfügt im System Usage-
Fenster über eine Anzeige, mit deren Hilfe Sie den 
Festplattencache überwachen können. Diese 
Anzeige ist nur sichtbar, wenn im „Playback 
Engine“-Dialogfeld eine feste Cache Size 
ausgewählt ist.

Die Disk Cache-Anzeige gibt den zugewiesenen 
Speicherplatz an, der für das Caching von Audio in 
der Timeline verwendet wird (bis zum ausgewählten 
Arbeitsspeicher für die Disk Cache-Einstellung in 
der Playback Engine. Ein zusätzlicher Spitzenwert-
Anzeiger zeigt an, wie viel des zugewiesenen 
Arbeitsspeichers für das Caching der Session 
benötigt wird.

System Usage-Fenster

Systemauslastungs-Fenster mit Disk Cache-Anzeige
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Speicheranzeige

Die Memory-Anzeige gibt an, wie viel installierter 
physikalischer Arbeitsspeicher (RAM) im System 
von Pro Tools belegt wird. Dazu gehört auch 
Speicherplatz, der von der Audio Engine, 
der Video Engine (wenn aktiviert), Plug-Ins 
und der Datenträgercache belegt wird. Sie zeigt 
nur den von Pro Tools im System genutzten 
Arbeitsspeicher an. Wenn sich die Memory-
Anzeige 100 % annähert, sollten Sie mehr RAM 
installieren oder die Datenträgercache-Einstellung 
im Playback Engine-Dialogfeld niedriger setzen.

DSP-Auslastungs-Anzeige
(Nur Avid HDX-Systeme)

Avid HDX-Systeme verfügen unter der 
Aktivitätsanzeige über drei zusätzliche Anzeigen: 

Voices

– zeigt die Gesamtzahl der zuweisbaren sowie 
die Anzahl der aktuell zugewiesenen Voices an. 
Hierzu zählen alle Voices, unabhängig davon, 
ob sie explizit oder dynamisch zugeordnet wurden, 
sowie alle Voices, die zum Routen der hostbasierten 
Verarbeitung verwendet wurden. 

Time Slots

– zeigt die Gesamtzahl der verfügbaren sowie die 
Anzahl der aktuell verwendeten DSP Time Slots an.

DSP

– zeigt an, wie viele der einzelnen DSP-Chips auf 
den jeweiligen Avid HDX-Karten derzeit für die 
Mixerkonfiguration und DSP-basierte Plug-Ins 
verwendet werden.

Verwalten von Systemressourcen
So verfolgen Sie die Auslastung der Ressourcen 
während einer Pro Tools-Session:

 Wählen Sie Window > System Usage.

Um die Verarbeitungslast zu reduzieren, haben Sie 
folgende Möglichkeiten:

 Verringern Sie die Automationsdichte dort, 
wo die größte Aktivität herrscht. Weitere 
Hinweise finden Sie unter „Thinning von 
Automation“ auf Seite 1099. 

 Deaktivieren Sie nicht benötigte Spureingänge 
und -ausgänge. Weitere Hinweise finden Sie 
unter „Deaktivieren von Spureingängen und -
ausgängen im Edit-oder Mix-Fenster“ auf 
Seite 239.

 Deaktivieren Sie nicht benötigte Spuren. 
Weitere Hinweise finden Sie unter 
„Deaktivieren von Spuren“ auf Seite 249.

 Deaktivieren Sie nicht benötigte DSP-Plug-Ins. 
Weitere Hinweise finden Sie unter 
„Deaktivieren von Inserts“ auf Seite 1041.

System Usage-Fenster (hier für Pro Tools|HDX 2)

Voices

Time Slots

DSP-
Nutzung
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Kapitel 7: I/O-Setup

Im I/O Setup-Dialogfeld stehen Ihnen Tools zum Kennzeichnen, Formatieren und Zuweisen von 
Pro Tools-Eingangs-, Ausgangs-, Insert- oder Bus-Signalpfaden für jede Session je nach Ihrem Pro Tools-
System zur Verfügung. Das I/O-Setup unterstützt auch Signalpfade für PRE (Mikrofonvorverstärker) 
und weiterhin können Sie auch einen Verzögerungsausgleich für Hardware-Inserts konfigurieren.

Das I/O Setup-Dialogfeld bietet eine grafische Darstellung (Kanalmatrix) des Signalwegs der physikalischen 
Ein- und Ausgänge aller im Pro Tools-System angeschlossenen Audio-Interfaces. Wie bei einer virtuellen 
Patchbay ermöglicht es das I/O-Setup, eine Verbindung zwischen den physikalischen Ein- und Ausgängen 
der Audio-Interfaces mit den Pro Tools-Ein- und -Ausgangskanälen herzustellen. Bei Avid HDX- und 
HD Native-Systemen spiegeln manche dieser Einstellungen die Routing-Steuerelemente im Hardware 
Setup-Dialogfeld wider, d. h., die in einem Dialogfeld vorgenommenen Routing-Änderungen werden im 
jeweils anderen Dialogfeld übernommen. Das I/O-Setup unterstützt auch die Erstellung von internen 
Mixbussen sowie die Erstellung und Zuweisung von Ausgangsbussen.

I/O-Setup eines Avid HDX-Systems mit HD OMNI und HD I/O

Kanalmatrix

Registerkarten für 
Pfadtypen

Status aktiv/inaktiv
Status

Path Format-Selektor

Spalte mit
Pfadnamen

Pfad-Tools

Input und Output-
Selektoren

Bezeichnung für den Interface-Namen

Import/Export-
Einstellungen

Erweiterungs-
optionen
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Öffnen des I/O Setup-Dialogfelds
Das I/O Setup-Dialogfeld kann über das 
Anwendungsfenster (bei geschlossener Session) 
oder innerhalb einer Session (also bei geöffneter 
Session) geöffnet werden.

So öffnen Sie das I/O Setup-Dialogfeld:

1 Vergewissern Sie sich, dass Ihre Audio-
Interfaces im Hardware Setup-Dialogfeld 
aktiviert und richtig konfiguriert sind. Siehe 
„Konfigurieren der Pro Tools-
Hardwareeinstellungen“ auf Seite 58.

2 Wählen Sie Setup > I/O. 

Schließen des I/O 
Setup-Dialogfelds

So schließen Sie das I/O Setup-Dialogfeld und 
speichern die Änderungen:

 Klicken Sie auf OK.

Pro Tools überprüft verschiedene Routing-
Einstellungen (um Rückkoppelungsschleifen zu 
vermeiden). Falls Einstellungen miteinander in 
Konflikt stehen oder ungültig sind, müssen Sie 
diese zuerst korrigieren (siehe „Gültige Pfade und 
Voraussetzungen“ auf Seite 95).

So schließen Sie das I/O Setup-Dialogfeld, ohne 
die Änderungen zu speichern:

 Klicken Sie auf Cancel.

Navigieren im I/O 
Setup-Dialogfeld

So scrollen Sie im I/O Setup-Dialogfeld nach links 
oder nach rechts:

 Drücken Sie Alt + Seite auf/ab (Windows) bzw. 
Wahl + Bild nach oben/unten (Mac).

Pro Tools-Signalpfade
Ein Signalpfad ist eine logische Gruppierung 
mehrerer Aus- und Eingänge oder Busse mit 
gemeinsamen Namen und (Kanal-)Format. 
Das I/O Setup-Dialogfeld erlaubt Ihnen, Pfade 
anhand Ihrer Studiokonfiguration und den 
Anforderungen eines jeden Projekts zu erstellen, 
festzulegen und zu benennen.

Haupt- und Nebenpfade

Pfade in Pro Tools-Spuren und dem I/O-Setup 
umfassen Hauptpfade (main paths) und 
Nebenpfade (sub-paths).

Hauptpfade. – Hauptpfade sind logische 
Gruppierungen von Eingängen, Inserts, Bussen 
und Ausgängen. So enthält beispielsweise ein 
Master-Stereoausgangspfad den rechten und den 
linken Kanal. 

Nebenpfade. – Nebenpfade entsprechen einem 
Signalfluss innerhalb eines Hauptpfads. So besteht 
etwa ein Standard-Stereoausgangsbus-Pfad aus 
zwei Mono-Nebenpfaden: einem linken und einem 
rechten. Monospuren und Sends können auf einen 
der beiden Mono-Nebenpfade eines Stereo-
Ausgangsbus-Pfads geroutet werden. 

Haupt- und Nebenpfade im I/O Setup-Dialogfeld 
(Input-Registerkarte)

Das Anlegen und Benennen von 
Nebenpfaden eignet sich besonders für 
komplexe Mischvorgänge, wie etwa im 
5,1-Surround-Format. 
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Pfade in Sessions
In einer Session wird Audio mithilfe der Track 
Input-, Output-, Insert- und Send-Selektoren von 
und auf Spuren, Sends und Inserts geroutet.

Wenn Sie auf einen Track Input-, Output-, Insert- 
oder Send-Selektor klicken, wird der Pfad, der im 
I/O-Setup angelegt wurde, in der Liste der verfüg-
baren Pfade angezeigt (siehe „Zuweisen von 
Audio-Ein- und Ausgängen an Spuren“ auf 
Seite 236).

Pfadkonfigurationen und 
I/O-Einstellungen
Pro Tools-Systeme können unterschiedliche 
Pfadkonfigurationen aufweisen. Diese werden 
durch folgende Faktoren bestimmt:

• bei Pro Tools-Systemen durch den Audio-
Interface-Typ bzw. andere physikalische 
Ein- und Ausgänge (einschließlich 
integrierte Hardware)

• bei Avid HDX- und HD Native-Systemen durch 
Anzahl und Typ der Audio-Interfaces

Pfadkonfigurationen werden in Pro Tools als 
I/O-Einstellungen gespeichert.

I/O-Einstellungen werden zusammen mit der 
Pro Tools-Session und mit dem System gespeichert. 
Sie können wählen, ob die I/O-Einstellungen, 
die mit der Session gespeichert wurden, die I/O-
Einstellungen des Systems überschreiben sollen 
(siehe „Sessions Overwrite Current I/O Setup When 
Opened“ auf Seite 81).

Nicht verfügbare Elemente (einschließlich 
Hardware, Pfade und benötigte Ressourcen) 
bleiben in der Session als inaktive Elemente 
bestehen (siehe „Aktivieren bzw. Deaktivieren 
von Pfaden“ auf Seite 93).

Sie können beim Erstellen einer neuen Session 
die gewünschten I/O-Einstellungen festlegen. 
So können Sie beispielsweise aus den werkseitig 
installierten Standard-Einstellungen, den zuletzt 
verwendeten Einstellungen („Last Used“) oder 
Dateien mit anwenderdefinierten I/O-
Einstellungen wählen.

Standard-I/O-Einstellungen

Pro Tools enthält ab Werk bereits I/O Setup-
Einstellungen, sodass Sie sofort mit der Arbeit 
beginnen können (siehe „Werkseitige I/O-
Einstellungen“ auf Seite 100). Sie benötigen das 
I/O Setup-Dialogfeld also nur, wenn Sie die 
Standardeinstellungen für die Eingangs- und 
Ausgangspfade anpassen möchten, oder bei 
Änderungen an der System-Hardware (etwa 
durch Einbau einer Erweiterungskarte für ein 
HD I/O oder bei Hinzufügen oder Entfernen eines 
Audio-Interface). 

Sie können die Standardeinstellungen für eine I/O 
Settings-Registerkarte jederzeit wiederherstellen, 
indem Sie auf die Default-Schaltfläche klicken. 
Diese Pfade sind in Session-Spuren verfügbar und 
werden in das I/O-Setup übernommen. 

Sie können Ihre I/O Setup-Konfiguration jederzeit 
den Anforderungen eines spezifischen Projekts 
anpassen (siehe „Anpassen der I/O-Einstellungen“ 
auf Seite 82).

Ausführliche Informationen hierzu finden 
Sie unter „Werkseitige I/O-Einstellungen“ 
auf Seite 100 und unter „I/O-
Einstellungsdateien“ auf Seite 101.
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I/O Setup-Registerkarten
Im I/O Setup-Dialogfeld werden Registerkarten 
angezeigt, über die Sie auf die I/O-Einstellungen 
zugreifen können.

Öffnen einer I/O 
Setup-Registerkarte

So öffnen Sie eine I/O Setup-Registerkarte:

 Klicken Sie im oberen Bereich des I/O Setup-
Dialogfelds auf die entsprechende Registerkarte.

Input-Registerkarte
Die Input-Registerkarte des I/O Setup-Dialogfelds 
erlaubt Ihnen, Pro Tools-Eingangskanäle zu 
erstellen und zuzuweisen, um Audiosignale über 
die physikalischen Eingänge Ihrer Audio-
Hardware einzuspeisen. 

Auf der Input-Registerkarte konfigurieren Sie 
Namen, Formate und Quellkanäle (analog oder 
digital) für Eingangssignalpfade. 
Mehrkanaleingangspfade (Stereo oder Mehrkanal) 
können eine beliebige Anzahl von Nebenpfaden 
besitzen. Eingangskanäle können sich 
überschneidende Eingangspfade haben. Input-
Namen, Kanalanzahl und die Zuweisung 
physikalischer Eingänge werden gemeinsam mit 
dem System und der Session gespeichert und 
können entsprechend wieder aufgerufen werden.

Halten Sie die Befehlstaste (Mac) bzw. 
die Strg-Taste (Windows) gedrückt und 
wechseln Sie mithilfe der Pfeiltasten nach 
links und rechts zwischen den Registerkarten 
des I/O Setup-Dialogfelds.

Es wird empfohlen, beim Anpassen des 
I/O-Setups die systemspezifischen Optionen 
zuerst zu konfigurieren: Eingang, Ausgang, 
Insert, Mikrofonvorverstärker und Hardware-
Insert-Verzögerung. Konfigurieren Sie dann 
die Bus-Registerkarte. Wenn Sie Ihr System 
konfiguriert haben, sollte es nicht mehr nötig 
sein, die Konfiguration zu ändern, sofern Sie 
nicht Hardware (etwa Audio-Interfaces) 
hinzufügen oder entfernen. Siehe „Anpassen 
der I/O-Einstellungen“ auf Seite 82.

I/O Setup, Input-Registerkarte
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Output-Registerkarte
Die Output-Registerkarte des I/O Setup-Dialogfelds 
unterstützt die Erstellung und Zuweisung von 
Pro Tools-Ausgangskanälen, um Audiosignale an 
die physikalischen Ausgänge Ihrer Audio-Hardware 
zu leiten. 

Auf der Output-Registerkarte konfigurieren Sie 
Namen und Formate für Ausgangssignalpfade. 
Ausgangskanäle können sich überschneidende 
Ausgangspfade besitzen. Ausgangsnamen, 
Kanalanzahl und die Zuweisung an physikalische 
Ausgänge werden gemeinsam mit dem System 
und der Session gespeichert und können 
entsprechend wieder aufgerufen werden.

Bus-Registerkarte
Die Bus-Registerkarte des I/O Setup-Dialogfelds 
unterstützt die Erstellung und Bearbeitung 
interner Mix- und Ausgangsbusse. Über die Bus-
Registerkarte können Sie auch Ausgangsbusse 
Ausgangspfaden zuweisen (entsprechend der 
Konfiguration auf der Output-Registerkarte des 
I/O Setup-Dialogfelds). 

Konfigurieren Sie Bus-Pfadnamen und -Formate und 
weisen Sie beliebige Hauptbuspfade beliebigen 
verfügbaren Ausgängen mit gleich vielen oder mehr 
Kanälen zu. Mehrkanalbuspfade (Stereo oder höher) 
können eine beliebige Anzahl von Nebenpfaden 
besitzen. Ausgangsbusnamen, interne Mixbusnamen 
und Kanalanzahl werden gemeinsam mit der Session 
gespeichert und wieder aufgerufen.

I/O Setup, Output-Registerkarte

I/O Setup, Bus-Registerkarte

Weitere Informationen finden Sie unter 
„Konfigurieren von Bussen“ auf Seite 96.
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Insert-Registerkarte
Die Insert-Registerkarte des I/O Setup-Dialogfelds 
unterstützt die Erstellung und Bearbeitung von 
Hardware-Insert-Signalpfaden für den Pro Tools-
Mixer. Hardware-Inserts können Audiosignale 
durch ein externes Gerät, das mit den parallelen Ein- 
und Ausgängen eines Pro Tools-Audio-Interface 
verbunden ist, routen. Sie können somit das 
Audiomaterial auf einer Spur mit einem Hardware-
Insert in Echtzeit bearbeiten. 

Insert-Pfade benötigen Audio-Interface-Ein- und 
Ausgänge und werden durch die I/O Setup-
Konfiguration Ihres Systems bestimmt.

Mic Preamps-Registerkarte
Auf der Mic Preamps-Registerkarte des I/O Setup-
Dialogfelds können Sie Signalpfade für ein oder 
mehrere multifunktionale PRE-Mikrofonvorver-
stärker Audio-Interfaces zuweisen. Weitere 
Informationen hierzu finden Sie im PRE-Handbuch.

I/O Setup, Insert-Registerkarte

Weitere Informationen finden Sie unter 
„Verwenden von Hardware-Inserts“ auf 
Seite 1067.

Mic Preamps-Registerkarte
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H/W Insert Delay 
(Compensation)-Registerkarte
Um Verzögerungen (Latenz) von externen 
Hardwaregeräten (etwa einem Effektgerät), die Sie 
in Ihrer Session verwenden, auszugleichen, können 
Sie den Wert für den Verzögerungsausgleich 
(in Millisekunden) für jedes externe Gerät 
einstellen. Diese Werte werden von der Delay 
Compensation Engine dazu verwendet, bei 
Verwendung eines Hardware-Inserts und 
aktiviertem Verzögerungs-ausgleich die 
Eingangspfade zeitlich abzustimmen.

I/O Setup-Dialogfeld: 
Signalpfad-Einstellungen
In Abhängigkeit von der I/O Setup-Registerkarte 
kann die grafische Darstellung des I/O-Setups 
folgende Einstellungen zur Konfiguration der 
Signalroutingpfade enthalten.

Input und Output-Selektoren. – über diese wählen 
Sie die physikalischen Ports des Audio-Interface zum 
Routen auf die Ein- und Ausgänge in Pro Tools. 
Ports können als Kanalpaare ausgewählt werden. 
Die verfügbaren Ports für jedes angezeigte Interface 
hängen von den Einstellungen im Hardware Setup-
Dialogfeld ab. Wenn beispielsweise die AES/EBU-
Ein- und -Ausgänge eines Interface im Hardware 
Setup-Dialogfeld aktiviert sind, stehen sie zum 
Routing im I/O Setup-Dialogfeld zur Verfügung. 
Die Funktionen des Input- und Output-Selektors 
stehen auch auf der Main-Registerkarte des 
Hardware Setup-Dialogfelds bereit.

Spalte mit den Pfadnamen. – diese zeigt die zur 
Auswahl stehenden Pfade sowie den Namen jedes 
definierten Pfads an. Pfadnamen können 
umbenannt werden.

Feld für Insert-Verzögerungsausgleich

Weitere Informationen finden Sie unter 
„Einstellen eines Hardware-Insert-
Verzögerungs-Offsets“ auf Seite 1031.

Signalpfad-Einstellungen im I/O Setup-Dialogfeld 
(Input-Registerkarte)

Spalte mit 
Pfadnamen

Path Format-Selektor

Input-Selektor

Expand/Collapse-
Schaltfläche

Statusanzeige 
aktiv/inaktiv

Kanalmatrix
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Expand/Collapse-Schaltfläche. – blendet die zum 
Hauptpfad gehörigen Nebenpfade ein und aus 
(nur Eingangs- und Buspfade).

Statusanzeige aktiv/inaktiv. – diese Kontroll-
kästchen zeigen den Status (aktiv/inaktiv) jedes 
Pfads an.

Path Format-Selektor. – hiermit können Sie den 
Typ bzw. das Format (Mono, Stereo, Quad oder 
5.1) jedes definierten Pfads anzeigen und 
auswählen (Mehrkanalformate werden nur bei 
Pro Tools HD-Systemen unterstützt).

Kanalmatrix. – anhand dieser werden Pfade 
bestimmten Interfaces und Kanälen zugeordnet. 

I/O Setup-Schaltflächen
Abhängig von der I/O Setup-Registerkarte kann 
das I/O Setup-Dialogfeld folgende Schaltflächen, 
Menüs und Selektoren zur Konfiguration des 
Signalroutings enthalten.

New Path-Schaltfläche. – dient zum Anlegen eines 
neuen Pfads auf den Signalpfad-Registerkarten für 
Eingang, Ausgang, Insert, Bus oder Mic-Preamp.

New Sub-Path-Schaltfläche. – diese ist auf den 
Registerkarten für Eingang, Ausgang, Insert, 
Bus oder Mic-Preamp vorhanden und dient zum 
Anlegen neuer Nebenpfade.

Delete Path-Schaltfläche. – dient zum Löschen 
eines ausgewählten Pfads oder Nebenpfads auf 
den Signalpfad-Registerkarten für Eingang, 
Ausgang, Insert oder Bus.

Default-Schaltfläche. – dient zum Zurücksetzen 
eines Pfadtyps auf dessen Standardpfadkonfiguration 
(abhängig vom verwendeten Interface und der 
Hardware-Konfiguration).

Import Settings-Schaltfläche. – zum Importieren 
einer I/O-Einstellungsdatei zur Neukonfiguration 
des I/O Setup-Dialogfelds. Import Settings 
importiert ausschließlich die Einstellungen für 
die aktuell angezeigte Registerkarte des I/O Setup-
Dialogfelds (etwa für die Input-Registerkarte).

Export Settings-Schaltfläche. – dient zum 
Speichern von I/O-Einstellungen als Datei, die in 
andere Sessions importiert oder auf anderen 
Pro Tools-Systemen verwendet werden kann. 
Export Settings exportiert die Einstellungen für 
alle Registerkarten des I/O Setup-Dialogfelds.

Show Last Saved Setup. – wird bei der 
Übertragung von Sessions in bestimmten 
Situationen im I/O Setup-Dialogfeld eingeblendet. 
Weitere Informationen zu dieser Funktion erhalten 
Sie unter „Letztes gespeichertes und aktuelles 
Setup anzeigen“ auf Seite 104.

Cancel-Schaltfläche. – dient zum Schließen des 
I/O Setup-Dialogfelds, ohne die Änderungen 
zu speichern.

OK-Schaltfläche. – dient zum Schließen 
und Speichern aller Änderungen im I/O 
Setup-Dialogfeld.

Signalpfad-Einstellungen im I/O Setup-Dialogfeld 
(Input-Registerkarte)

Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die Default-
Schaltfläche, um die Standardeinstellungen 
für alle Registerkarten des I/O Setup-
Dialogfelds wiederherzustellen.

Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die Import 
Settings-Schaltfläche, um die Einstellungen 
für alle Registerkarten des I/O Setup-
Dialogfelds zu importieren.
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I/O Setup-Optionen
Pro Tools Systeme besitzen zusätzliche 
I/O Setup-Optionen, abhängig von der im I/O 
Setup-Dialogfeld angezeigten Registerkarte. 
Dazu gehören Standardeinstellungen für das 
Signal-Routing für Pegelanzeigen und das 
Abhören sowie Standard-Spuranordnungen für 
das Mischen im Mehrkanalformat.

Optionen zum Ausgleichen 
von Verzögerungen nach 
der Aufnahme
(Nur Pro Tools|HDX- und Pro Tools|HD 
Native-Systeme)

Pro Tools bietet zwei Optionen zum Ausgleich 
von Eingangs- und Ausgangsverzögerungen nach 
der Aufnahme (aufgrund einer inhärenten Latenz 
der A/D- und D/A-Wandler der Audio-Interfaces).

Compensation for Input Delays After 
Record Pass

Wenn diese Option aktiviert ist, wird der 
automatische Ausgleich für alle analogen und 
digitalen Eingangsverzögerungen bei Avid HD-
Interfaces aktiviert. Aktivieren Sie diese Option in 
allen Aufnahmesituationen. Nehmen Sie aus einer 
digitalen Quelle auf, muss sowohl die Option 
Compensation for Input Delays After Record Pass 
als auch die Option Compensation for Output 

Delays After Record Pass aktiviert sein.

Die Option Compensation for Input Delays After 

Record Pass ist nur auf der Input-Registerkarte 
des I/O Setup-Dialogfelds verfügbar.

Compensation for Output Delays After 
Record Pass

Wenn diese Option aktiviert ist, wird der 
automatische Ausgleich für alle analogen und 
digitalen Ausgangsverzögerungen bei Avid HD-
Audio-Interfaces aktiviert. Aktivieren Sie diese 
Option, wenn eine Synchronisierung mit einem 
externen Taktgeber vorliegt. Nehmen Sie aus einer 
digitalen Quelle auf, muss sowohl die Option 
Compensation for Input Delays After Record Pass 
als auch die Option Compensation for Output 

Delays After Record Pass aktiviert sein.

Die Option Compensation for Output Delays After 

Record Pass ist nur auf der Output-Registerkarte 
des I/O Setup-Dialogfelds verfügbar.

Output Meter Path
Der Output Meter Path-Selektor bestimmt welche 
Ausgangs- bzw. Buspfade von der Output-Anzeige 
beim Transport abgehört werden (siehe 
„Ausgangsanzeigen“ auf Seite 1013).

Der Output Meter Path-Selektor ist auf der Output-
Registerkarte des I/O Setup-Dialogfelds verfügbar.

So richten Sie Ausgangspegel-Pfade ein:

1 Wählen Sie Setup > I/O-Setup.

2 Klicken Sie auf die Output-Registerkarte.

3 Wählen Sie über den Ausgangspegel-Pfadselektor 
den gewünschten Ausgangspfad für das Metering.

Controller Meter Path
Der Controller Meter Path-Selektor legt den in 
den Ausgangspegelanzeigen der D-Control- oder 
D-Command-Bedienoberfläche angezeigten Pfad 
fest. Weitere Informationen finden Sie in der 
Dokumentation Ihrer Bedienoberfläche.

Der Controller Meter Path-Selektor ist auf der Bus-
Registerkarte des I/O Setup-Dialogfelds verfügbar.

Signalpfad-Einstellungen im I/O Setup-Dialogfeld 
(Output-Registerkarte)
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Abhörpfade
Sie können den Ausgangspfad festlegen, über den 
das Abhören von Dateien und Clips in der Clipliste 
oder in Workspace-Browsern bzw. von mit 
AudioSuite verarbeitetem Material erfolgen soll.

Der Audition Paths-Selektor ist auf der Output- 
und der Bus-Registerkarte des I/O Setup-
Dialogfelds verfügbar.

Verwenden des Standardabhörpfads

Wenn Sie eine Datei oder einen Clip aus der Clipliste 
oder in einem Workspace-Browser vorhören bzw. 
beim Vorhören von mit AudioSuite verarbeitetem 
Material wird die Audio-Ausgabe von Pro Tools 
über den angegebenen Abhörpfad geroutet. 
Pro Tools weist dem ersten Hauptausgangspfad 
einen Standardabhörpfad des gleichen Formats zu. 
Sie können im I/O Setup-Dialogfenster auch einen 
anderen Abhörpfad auswählen.

Konfigurieren von Abhörpfaden

Sie können die Ausgänge zum Abhören des 
Audiomaterials in der Clipliste und Workspace-
Browsern bzw. von AudioSuite-Material unter 
Zuhilfenahme des Audition Paths-Popup-
Menüs angeben. 

Audition Paths-Hauptmenü. – das Hauptmenü 
enthält alle auf dem aktuellen System verfügbaren 
Pfadformate (Mono und Stereo auf allen Systemen, 
sowie LCR und Mehrkanal auf Pro Tools HD). 

Audition Paths-Untermenüs. – jede 
Pfadformatauswahl hat ein Untermenü, in dem die 
Ausgangspfade des jeweiligen Formats aufgelistet 
sind. (Das Mono-Untermenü enthält eine Liste der 
Ausgangspfade aller Formate.)

So konfigurieren Sie Abhörpfade:

 Wählen Sie im Audition Paths-Hauptmenü oder 
den entsprechenden Untermenüs den 
gewünschten Pfad aus.

Standardausgangsbus
Sie können Standard-Ausgangsbus-Pfade für neue 
Spuren in allen verfügbaren Formaten festlegen. 

Der Selektor für den Default Output Bus 
(Standardausgangsbus) ist auf der Output- 
und der Bus-Registerkarte des I/O Setup-
Dialogfelds verfügbar.

So legen Sie im I/O Setup-Dialogfeld einen 
Standardausgang für neue Spuren fest:

 Klicken Sie auf Default Output Bus und wählen 
Sie aus dem Popup-Menü ein Format und 
einen Ausgangsbuspfad.

Weitere Informationen zum Abhören von 
Audio finden Sie unter „Vorhören von 
Clips in der Clipliste“ auf Seite 276 und 
unter „Vorhören von Audio in 
Workspace-Browsern“ auf Seite 305.

Sie können einen Standardausgangsbus 
für interne Mixbusse und 
Ausgangspfade einstellen.
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AFL-/PFL-Pfad
(Nur Pro Tools HD mit Avid HDX oder 
HD Native-Hardware)

Spuren, die in einem der Modi AFL (After Fader 
Listen) oder PFL (Pre-Fader Listen) sologeschaltet 
wurden, werden auf den im AFL/PFL Path-
Selektor gewählten AFL-/PFL-Pfad geroutet.

Der AFL/PFL Path-Selektor ist auf der Output- 
und der Bus-Registerkarte des I/O Setup-
Dialogfelds verfügbar.

So wählen Sie den Ausgang für den AFL-/PFL-Pfad:

 Wählen Sie im AFL/PFL Path-Popup-Menü den 
gewünschten Pfad.

Einstellen des Pegels für AFL- oder PFL-Pfade

Sie können einen gesonderten Masterpegel für 
AFL/PFL-Pfade einstellen, der dann für alle AFL- 
und PFL-Solospuren gilt.

So stellen Sie den Pegel für AFL-/PFL-Pfade für 
AFL- und PFL-Soloschaltungen ein:

1 Wählen Sie Options > Solo Mode und wählen 
Sie den gewünschten Solo-Modus:

• Um den Pegel für AFL-Solospuren festzulegen, 
wählen Sie AFL aus.

• Um den Pegel für PFL-Solospuren festzulegen, 
wählen Sie PFL aus.

2 Halten Sie im Mix- oder Edit-Fenster die Strg-
Taste (Windows) bzw. die Befehlstaste (Mac) 
gedrückt und klicken Sie bei der gewünschten 
Spur auf die Solo-Schaltfläche.

3 Stellen Sie den AFL/PFL Path-Fader ein.

4 Klicken Sie auf die neue Faderposition (oder 
drücken Sie die Esc-Taste), um die Anzeige der 
Fader zu schließen.

AFL-/PFL-Stummschaltung 
(Ausgangspfad)
(Systeme ohne D-Control- oder 
D-Command-Bedienoberfläche)

Wenn Sie keine D-Control™- oder D-Command®-
Konsole einsetzen, können Sie beim Senden von 
Signalen an den AFL-/PFL-Pfad den normalen 
Pro Tools-Ausgangspfad stummschalten. Mithilfe 
des AFL/PFL Mutes (Output Path)-Selektors legen 
Sie den stummzuschaltenden Pfad fest.

Der AFL/PFL Path-Selektor ist auf der Output- 
und der Bus-Registerkarte des I/O Setup-
Dialogfelds verfügbar.

So legen Sie fest, welcher Ausgangspfad 
stummgeschaltet werden soll, wenn Spuren im 
AFL- oder PFL-Modus sologeschaltet werden:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die Output-Registerkarte, 
um sie zu aktivieren.

3 Wählen Sie im AFL/PFL Mutes (Output Path)-
Selektor den gewünschten Pfad.

4 Klicken Sie auf OK, um das I/O Setup-
Dialogfeld zu schließen und die dort 
vorgenommenen Änderungen zu speichern.

Ausführliche Informationen zur Verwendung 
von AFL- und PFL-Solo-Modus finden Sie 
unter „Solo-Modi“ auf Seite 246.

Mit der Auswahl „None“ als AFL-/PFL-Pfad 
können Sie den AFL- und den PFL-Solo-
Modus deaktivieren. Ist „None“ ausgewählt, 
kann weder AFL noch PFL verwendet werden.

Um den Masterpegel für AFL-/PFL-Pfade 
einzustellen, brauchen Sie die Spuren nicht 
auf Solo zu schalten. 

Um den Pegel für den AFL-/PFL-Pfad 
auf 0 dB einzustellen, drücken Sie 
Strg + Windows (Windows) bzw. Ctrl + 
Befehl (Mac) und klicken Sie auf die 
gewünschte Solo-Schaltfläche.

Weitere Informationen zur Verwendung von 
AFL- und PFL-Solo-Modus finden Sie unter 
„Solo-Modi“ auf Seite 246.
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Niedriglatenz-Monitoring
(Nur HD Native-Systeme)

Bei HD Native-Systemen kann das Niedriglatenz-
Monitoring über die Output-Registerkarte des 
I/O Setup-Dialogfelds aktiviert und deaktiviert 
werden. Zudem kann jeder verfügbare Ausgangspfad 
für Niedriglatenz-Monitoring festgelegt werden. 
Der Ausgangspfad für das Niedriglatenz-Monitoring 
kann eine beliebige Kanalanzahl besitzen (Mono bis 
7.1). Abhören mit geringer Latenz erfolgt 
standardmäßig über die Ausgänge 1–2.

So konfigurieren Sie Niedriglatenz-Monitoring im 
I/O-Setup-Dialogfeld:

1 Öffnen Sie das I/O Setup-Dialogfeld 
(Setup > I/O).

2 Klicken Sie auf die Output-Registerkarte.

3 Aktivieren Sie die Low Latency 
Monitoring-Option.

4 Über das Low Latency Monitoring-Popup-Menü 
können Sie den Ausgangspfad, den Sie 
verwenden möchten, auswählen.

5 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Standard-Abhörformat
(Nur Pro Tools HD)

Das Default Monitor Format-Popup-Menü dient zum 
Festlegen des Standard-Abhörformats (Stereo, 5.1 
oder 7.1). Es wird geöffnet, wenn ein neuer 
Ausgangspfad erstellt oder die Default-Schaltfläche 
betätigt wird. 

Diese Einstellung hat keinen Einfluss auf bestehende 
Pfaddefinitionen oder deren Pegelanzeige. Sie legt 
nur die Zuweisung der Kanäle bei neuen Pfaden im 
5.1-Format fest. 

Der Default Monitor Format-Selektor ist nur auf der 
Output- und Bus-Registerkarte im I/O Setup-
Dialogfeld verfügbar.

So wählen Sie ein Standard-Abhörformat:

 Wählen Sie im Default Path Order-Popup-Menü 
die Kanalzuweisung aus. 

5.1-Pfadanordnung
(Nur Pro Tools HD)

Über das 5.1 Path Order-Popup-Menü können Sie 
die Standard-Spurenanordnung für alle neu 
erstellten Spuren im 5.1-Format festlegen. 

Der 5.1 Path Order-Selektor ist auf der Input-, 
Output- und der Insert-Registerkarte des I/O 
Setup-Dialogfelds verfügbar.

So wählen Sie eine neue Standardanordnung für 
5.1-Format-Pfade (Spuren):

1 Wählen Sie Setup > I/O. 

2 Klicken Sie auf die Output-Registerkarte.

3 Verwenden Sie die 5.1 Default Path Order-
Einstellung, um die gewünschte Spuranordnung 
auszuwählen (C|24/Film, SMPTE/ITU, 
DTS/ProControl Monitoring oder D-Command/ 
D-Control). 

Embed Eleven Settings From
(Nur Eleven Rack-Systeme)

Wenn ein Eleven Rack mit Ihrem Pro Tools-
System verbunden ist, können Sie mit Pro Tools 
die aktuellen Eleven Rack Rig-Einstellungen 
während der Aufnahme in Audioclips einbetten, 
damit Sie sie später wieder aufrufen können. Das 
kann auch hilfreich sein, wenn Sie im Team 
arbeiten oder Sessions oder Clips auf ein anderes 
System übertragen möchten, das ebenfalls 
Eleven Rack verwendet, denn Ihre Einstellungen 
werden gemeinsam mit den Dateien übertragen.

Weitere Informationen zum Thema 
Mehrkanalmischung erhalten Sie unter 
Kapitel 47: „Surround-Setup“.
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Der Embed Eleven Setting From-Selektor bestimmt 
den Audioeingang, der zum Routen von Audio aus 
einem Eleven Rack in eine separate Audio-Interface 
verwendet wird. 

Der Embed Eleven Setting From-Selektor ist 
auf der Input-Registerkarte des I/O-Setup-
Dialogfelds verfügbar.

So betten Sie Rig-Einstellungen in Audio-
Aufnahmen ein:

1 Wählen Sie Setup > I/O-Setup.

2 Wählen Sie die Input-Registerkarte. 

3 Legen Sie im Embed Setting From-Menü den 
Eingang fest, über den Sie aufnehmen möchten, 
beispielsweise Eleven Rig L/R.

4 Erstellen Sie eine Audiospur und legen Sie 
ihren Input auf den entsprechenden Input auf 
dem Audio-Interface fest.

5 Schalten Sie die Spur scharf.

6 Nehmen Sie Ihren Part auf.

7 Die Einstellungen des aktuell geladenen Rigs 
werden in alle Audioclips eingebettet, 
die über den im Embed Setting From-Menü 
ausgewählten Eingang aufgenommen werden. 

Audioclips mit eingebetteten Rig-Daten sind im 
Edit-Fenster und in der Clipliste in Pro Tools 
mit einem kleinen Eleven Rack-Symbol 
gekennzeichnet.

Sessions Overwrite Current 
I/O Setup When Opened
Mit dieser Option wird bestimmt, ob beim Öffnen 
einer Session die für Ihr System konfigurierten 
I/O-Einstellungen für Input, Output und Insert 
durch die in einer Session gespeicherten I/O-
Einstellungen überschrieben werden. 

 Wird die Option Sessions Overwrite Current I/O 

Setup When Opened deaktiviert, übernimmt 
Pro Tools die Systemeinstellungen. Wählen Sie 
diese Option, um Sessions auf unterschiedlichen 
Systemen mit Pro Tools 8.1 oder höher zu öffnen 
(siehe „Session-Austausch“ auf Seite 103).

 Ist die Sessions Overwrite Current I/O 

Setup When Opened-Option aktiviert 
(Standardeinstellung), übernimmt Pro Tools die 
Session- anstatt der Systemeinstellungen. Wählen 
Sie diese Option, um Sessions auf Systemen mit 
älteren Pro Tools-Versionen (Pro Tools 8.0.x und 
niedriger) zu öffnen (siehe „Session-Austausch“ 
auf Seite 103). 

Dieselbe Methode gilt, wenn Sie Eleven Rack 
als Insert mit anderen Pro Tools-Systemen 
verwenden.

Die Option Sessions Overwrite Current 
I/O Setup When Opened aktiviert das 
Verhalten früherer Pro Tools-Versionen 
(vor Version 8.1). Diese Option ist 
standardmäßig aktiviert.

Aktivieren oder deaktivieren Sie diese Option 
auf einer Registerkarte des I/O Setup-
Dialogfelds, wirkt sich diese Änderung auch 
auf alle übrigen Registerkarten aus.
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Anpassen der I/O-
Einstellungen
Im Folgenden wird beschrieben, wie Sie Ihre I/O-
Einstellungen für ein bestimmtes Studio-Setup 
anpassen können. Vergewissern Sie sich, dass 
die Sessions Overwrite Current I/O Setup 

When Opened-Option nicht aktiviert ist, 
um sicherzustellen, dass Ihre Einstellungen nicht 
durch das Öffnen einer Session verändert werden.

So passen Sie I/O-Einstellungen an:

1 Öffnen Sie das I/O Setup-Dialogfeld 
(Setup > I/O).

2 Sie können bestehende I/O-Einstellungen 
aus einer PIO-Datei importieren (siehe 
„Importieren von I/O-Einstellungen“ auf 
Seite 101).

3 Doppelklicken Sie bei Avid HDX- und 
HD Native-Systemen auf die Bezeichnung 
oberhalb des Interface und geben Sie einen 
Namen ein.

4 Klicken Sie auf die Input-Registerkarte. 
Sie haben dann folgende Möglichkeiten:

• Erstellen Sie Pfade und Nebenpfade mitsamt 
Kanalanzahl und Zuweisungen physikalischer 
Eingänge, die Ihrer Studiokonfiguration 
entsprechen (siehe „Signal-Routing für 
Ausgangssignale“ auf Seite 86).

• Benennen Sie die Eingangs- und Nebenpfade 
entsprechend Ihrer Studiokonfiguration.

5 Klicken Sie auf die Output-Registerkarte. 
Sie haben dann folgende Möglichkeiten:

• Erstellen Sie Ausgangspfade mitsamt Kanalanzahl 
und Zuweisungen physikalischer Eingänge, die 
Ihrer Studiokonfiguration entsprechen.

• Benennen Sie die Ausgangspfade entsprechend 
Ihrer Studiokonfiguration. 

6 Wenn Sie Hardware-Inserts verwenden 
möchten, klicken Sie auf die Insert-
Registerkarte. Gehen Sie dann wie folgt vor:

• Erstellen Sie Insertpfade mitsamt Kanalanzahl 
und Zuweisungen physikalischer Eingänge, 
die Ihrer Studiokonfiguration entsprechen. 

• Benennen Sie die Insertpfade entsprechend Ihrer 
Studiokonfiguration. Benennen Sie die 
Insertpfade entsprechend der gängigen 
Branchenterminologie, etwa „Compressor“, 
„Reverb“, „EQ“, usw.

• Klicken Sie auf die H/W Insert Delay-
Registerkarte und geben Sie die entsprechende 
Eingangsverzögerung in Millisekunden für 
jedes Eingangs-/Ausgangs-Paar an, das Sie für 
Hardware-Inserts verwenden. (Siehe „H/W 
Insert Delay (Compensation)-Registerkarte“ auf 
Seite 75.)

7 Wenn Sie ein oder mehrere PRE-Geräte 
verwenden, klicken Sie auf die Mic Preamps-
Registerkarte und passen Sie die Konfiguration 
an (siehe PRE-Handbuch).

8 Klicken Sie auf die Bus-Registerkarte.

Falls Sie ein HD OMNI verwenden, 
konfigurieren Sie die Einstellungen des 
HD OMNI auf der Monitor-Registerkarte im 
Hardware Setup-Dialogfeld, bevor Sie das I/O-
Setup konfigurieren. Weitere Informationen 
hierzu finden Sie im HD OMNI-Handbuch.

Auf diese Weise können Sie eine Session 
vorbereiten, die Sie auf einem anderen 
System nutzen. Pfade, die auf Hardware 
verweisen, die auf dem aktuellen System nicht 
verfügbar ist, werden als inaktiv angezeigt.

Bei Systemen mit Avid HDX- oder HD Native-
Hardware werden die Standardnamen für 
Eingangs- und Ausgangspfade im I/O Setup-
Dialogfeld anhand der für das jeweilige 
Interface vergebenen anwenderdefinierten 
Namen bestimmt.
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9 Erstellen Sie interne Mixbus- und Nebenpfade. 
Vergewissern Sie sich, dass die Ausgangsbusse 
den richtigen Ausgangspfaden zugewiesen sind 
(siehe „Ausgangsbusse“ auf Seite 96).

10 Vergewissern Sie sich, dass die Sessions 
Overwrite Current I/O Setup When Opened-
Option auf keiner der Registerkarten des I/O 
Setup-Dialogfelds aktiviert ist. Auf diese 
Weise bleiben Ihre anwenderdefinierten I/O-
Einstellungen intakt, wenn Sie Sessions öffnen, 
die auf einem anderen System erstellt wurden.

11 Exportieren Sie Ihre I/O-Einstellungen, 
um ein Backup Ihrer aktuellen Einstellungen zu 
erstellen (siehe „Exportieren von I/O-
Einstellungen“ auf Seite 102).

12 Klicken Sie auf OK. Sie benötigen das I/O Setup 
also nur, wenn Sie Änderungen an der System-
Hardware durchführen, oder wenn Sie eine 
Session öffnen, die auf einem anderen System 
erstellt wurde (siehe „Session-Austausch“ auf 
Seite 103).

Konfigurieren der Hardware 
im I/O Setup-Dialogfeld
(Nur Avid HDX- und HD Native-Systeme)

In Avid HDX- und HD Native-Systemen können 
Sie festlegen, welche physikalischen Anschlüsse 
Ihres Audio-Interface auf welche auf der 
I/O Setup-Registerkarte verfügbaren Eingangs- 
bzw. Ausgangskanäle geroutet werden. Alle hier 
vorgenommenen Änderungen werden auch im 
Hardware Setup angezeigt, und umgekehrt 
(siehe „Konfigurieren der Pro Tools-
Hardwareeinstellungen“ auf Seite 58).

So konfigurieren Sie das I/O-Routing im I/O 
Setup-Dialogfeld:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die Input- oder Output-
Registerkarte, um den entsprechenden 
Pfadtyp anzuzeigen. 

3 Klicken Sie unterhalb des ersten Audio-Interface-
Symbols auf den Input- bzw. Output-Selektor des 
ersten Interface-Kanalpaars.

4 Wählen Sie im Popup-Menü ein physikalisches 
Anschlusspaar (wie etwa Analog 1–2), um es 
auf ein Pro Tools-Kanalpaar (wie etwa A 1–2) 
aus der Spalte mit den Pfadnamen zu routen.

5 Wiederholen Sie die beschriebenen Schritte für 
die übrigen Kanalpaare.

6 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Ausgangsbusse werden automatisch erstellt 
und Ausgängen zugewiesen, sobald neue 
Ausgangspfade erstellt werden.

HD MADI und Pro Tools-Systeme wie etwa 
Mbox Pro oder 003 sind „fest verdrahtet“ und 
können nicht verändert werden. Klicken Sie im 
Hardware Setup-Dialogfeld auf die Launch 
Setup App-Schaltfläche, um konfigurierbare 
Einstellungen für Hardware von anderen 
Herstellern sowie integrierte 
Hardware aufzurufen.

I/O Channel Selektor-Popup-Menü

Der Abhörpfad des HD OMNI ist fest 
eingestellt und kann im I/O Setup-
Dialogfeld nicht geändert werden. Der 
Abhörpfad des HD OMNI kann auf der 
Monitor-Registerkarte des Hardware 
Setup-Dialogfelds konfiguriert werden.
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Routen eines Pro Tools-
Ausgangspaars auf 
mehrere Ziele
Mithilfe des I/O Setup-Dialogfelds können Sie ein 
Pro Tools-Kanalpaar auf mehrere Ausgänge eines 
Audio-Interface routen. Wenn Sie beispielsweise 
die Ausgänge Analog 1–2 und Analog 3–4 dem 
Pro Tools-Ausgangspaar 1–2 zuweisen, wird beim 
Senden eines Signals an die Pro Tools-Ausgänge 
1–2 dieses Signal gleichzeitig an beide 
Ausgangspaare des Audio-Interface geroutet.

Sie haben somit die Möglichkeit, dasselbe Signal 
(wie etwa ein Stereo-Paar, eine Stem-Mischung 
oder eine Mehrkanalmischung) an mehrere Ziele 
gleichzeitig zu senden (wie etwa an mehrere 
Geräte für das Mastering).

Die Anzahl der Ziel-Ausgänge wird nur durch die 
im System vorhandenen Ausgänge begrenzt.

Sie können Pro Tools-Ausgangspaare im 
Hardware Setup-Dialogfeld auch auf mehrere 
Ausgänge eines Audio-Interface routen.

So routen Sie ein Pro Tools-Ausgangskanalpaar auf 
mehrere Ausgangsanschlüsse des Audio-Interface:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die Output-Registerkarte. 

3 Klicken Sie unterhalb des Audio-Interface-
Symbols auf den Output-Selektor eines 
Interface-Kanalpaars. 

4 Wählen Sie im Popup-Menü ein physikalisches 
Anschlusspaar (wie etwa Analog 1–2), um es 
auf das entsprechende Pro Tools-Kanalpaar 
(wie etwa A 1–2) aus der Spalte mit den 
Pfadnamen auf der linken Seite zu routen.

5 Klicken Sie bei gedrückter Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) erneut auf 
denselben Output-Selektor und wählen Sie im 
selben Popup-Menü ein weiteres Ausgangspaar.

Dem Namen des Ausgangs wird ein Pluszeichen 
(+) vorangestellt, um anzuzeigen, dass mehrere 
Ausgangsanschlüsse ausgewählt sind. Im Popup-
Menü wird jedes diesem Pro Tools-Ausgangspaar 
zugewiesene physikalische Anschlusspaar durch 
ein Häkchen gekennzeichnet.

6 Wiederholen Sie die beschriebenen Schritte, 
um weitere Ausgänge auszuwählen. 

7 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Die Zuweisungen der Ausgangspfade können 
sich in bestimmten Situationen überschneiden. 
Weitere Hinweise finden Sie unter „Gültige 
Pfade und Voraussetzungen“ auf Seite 95.
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Signal-Routing für Eingangssignale
Das folgende Beispiel zeigt den Signalfluss von einem physikalischen analogen Eingang eines 
HD OMNI-Audio-Interface über den Pro Tools-Audioeingangspfad auf einen Eingang einer Audiospur 
im Pro Tools-Mixer:

(1) Physikalischer Eingang. – bei Avid HD-
Interfaces, wie etwa HD OMNI, werden die 
physikalischen Eingänge, die in Pro Tools zur 
Verfügung stehen, auf der Main-Registerkarte des 
Hardware Setup-Dialogfelds eingestellt. (Dieser 
Selektor wird ebenfalls auf der Input-Registerkarte 
des I/O Setup-Dialogfelds angezeigt.) 

Eingangssignalpfad von HD OMNI in den Pro Tools-Mixer gemäß Zuweisung im I/O Setup-Dialogfeld

3

2

1

Die physikalischen Eingänge von Pro Tools-
Systemen wie etwa Mbox Pro oder 003 sind 
„fest verdrahtet“. Klicken Sie im Hardware 
Setup-Dialogfeld auf die „Launch Setup App“-
Schaltfläche, um konfigurierbare Einstellungen 
für Hardware von Drittanbietern und 
eingebaute Hardware aufzurufen.
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(2) Eingangspfad. – die Haupteingangspfade und 
Nebenpfade werden über die Zuweisungen in der 
Kanalmatrix im I/O Setup-Dialogfeld auf die 
physikalischen Eingänge geroutet. In diesem 
Beispiel wird das Audiosignal von den 
physikalischen Eingängen Analog 1–2 des 
HD OMNI auf die Pro Tools-Eingangskanäle 
A 1–2 geroutet.

(3) Eingang der Spur. – die Eingangspfade und 
Nebenpfade werden durch Auswählen des Pfads 
(oder Nebenpfads) im Track Input-Selektor auf die 
Spureingänge des Pro Tools-Mixers geroutet. 
In diesem Beispiel wird der Eingangsnebenpfad 
A1 auf den Eingang der Spur „Audio 1“ geroutet.

Signal-Routing für Ausgangssignale
Das folgende Beispiel zeigt den Signalfluss vom Ausgang einer Audiospur über einen Ausgangsbus, 
der einem Ausgangspfad zugewiesen ist, zu einem physikalischen Ausgang eines HD I/O-Audio-Interface:

Ausgangssignalpfad einer Audiospur zum physikalischen Ausgang gemäß Zuweisung im I/O Setup-Dialogfeld

3

4

2

1
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(1) Ausgang einer Spur. – das Audiosignal wird 
von der Festplatte aus abgespielt und vom Ausgang 
der Spur auf den Ausgangsbus „B 1–2“ geroutet.

(2) Ausgangsbuspfad. – der Ausgangsbus wird auf 
der Bus-Registerkarte des I/O Setup-Dialogfelds 
festgelegt. Auf der Bus-Registerkarte des I/O Setup-
Dialogfelds ist der Ausgangsbus „B 1-2“ dem 
Ausgang „B 1-2“ zugeordnet, der auf der Output-
Registerkarte des I/O Setup-Dialogfelds 
festgelegt ist.

(3) Ausgangspfad. – auf der Output-Registerkarte 
des I/O Setup-Dialogfelds wird die Kanalmatrix 
verwendet, um den Ausgangspfad (dem der 
Ausgangsbus zugewiesen ist) auf physikalische 
Ausgänge zu routen. 

(4) Physikalischer Ausgang. – bei Avid HD-
Interfaces wie etwa HD OMNI werden die 
physikalischen Ausgänge, die in Pro Tools zur 
Verfügung stehen, auf der Main-Registerkarte des 
Hardware Setup-Dialogfelds eingestellt (dieser 
Selektor wird auch auf der Output-Registerkarte 
des I/O Setup-Dialogfelds angezeigt).

Erstellen neuer Pfade
Im I/O Setup-Dialogfeld können Sie neue Pfade 
mit anwenderdefinierten Namen, Formaten und 
Zuweisungen an physikalische Ein- und Ausgänge 
erstellen. Anwenderdefinierte Pfadnamen werden 
in den Selektoren für Input, Output, Insert und Bus 
einer Sessionspur angezeigt.

So erstellen Sie einen neuen Pfad:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die Input-, Output-, Insert- oder 
Bus-Registerkarte, um den entsprechenden 
Pfadtyp anzuzeigen.

3 Klicken Sie auf New Path. 

4 Geben Sie im New Paths-Dialogfeld die Anzahl 
der neu zu erstellenden Pfade, die Kanalanzahl 
jedes Pfads und die Pfadnamen an.

5 Sie haben folgende Möglichkeiten:

• Wenn Sie weitere Pfade hinzufügen möchten, 
klicken Sie auf die Add Row-Schaltfläche (+).

• Um einen Pfad zu entfernen, klicken Sie auf die 
Remove Row-Schaltfläche (–).

Die physikalischen Ausgänge von Pro Tools-
Systemen wie etwa Mbox Pro oder 003 sind 
„fest verdrahtet“. Klicken Sie im Hardware 
Setup-Dialogfeld auf die Launch Setup App-
Schaltfläche, um konfigurierbare Einstellungen 
für Hardware von anderen Herstellern und 
integrierte Hardware aufzurufen.

New Paths-Dialogfeld

Fügen Sie einen neuen Pfad hinzu, indem Sie 
Befehl + N (Mac) bzw. Strg + N (Windows) 
drücken, oder indem Sie auf dem Ziffernblock 
Befehl + Pluszeichen (+) (Mac) bzw. 
Strg + Pluszeichen (+) (Windows) eingeben. 



Pro Tools-Referenzhandbuch88

6 Aktivieren (bzw. deaktivieren) Sie die New 
Paths-Optionen Add the Default Channel 

Assignments und Auto-Create Sub-paths.

7 Klicken Sie auf Create.

8 Weisen Sie den Pfad einem bestimmten Audio-
Interface (nur auf der Output- und der Insert-
Registerkarte verfügbar). Siehe „Zuweisung 
von Kanälen zu Hardware-Ein- und 
Ausgängen“ auf Seite 94.

9 Wiederholen Sie die beschriebenen Schritte 
zur Konfiguration aller anderen Pfadtypen 
(Eingang, Ausgang, Insert oder Bus).

10 Klicken Sie auf OK, um die Einstellungen zu 
speichern und das I/O Setup-Dialogfeld zu 
schließen. Falls Pfade gleich benannt sind, 
werden Sie aufgefordert, diese Namen vor 
dem Schließen des I/O Setup-Dialogfelds zu 
korrigieren. Weitere Informationen finden 
Sie unter „Gültige Pfade und Voraussetzungen“ 
auf Seite 95.

New Paths-Dialogfeld
Das New Paths-Dialogfeld unterstützt die Erstellung 
neuer Pfade auf der Input-, Output-, Bus- und Insert-
Registerkarte des I/O Setup-Dialogfelds.

New Path Row-Einstellungen

Number of New Paths. – geben Sie die Anzahl 
der neu zu erstellenden Pfade an (oder einen 
bestimmten Typ, etwa „Bus“).

Pfadformat. – wählen Sie im Path Format-Selektor 
die Kanalanzahl aus.

Pfadname. – geben Sie einen Pfadnamen ein. 
Wenn Sie mehr als einen Pfad erstellen, wird die 
Nummer jedes neuen Pfads an den Pfadnamen 
angehängt (etwa Bus 1, Bus 2, Bus 3).

Add/Remove Rows. – klicken Sie auf die Add 
Row-Schaltfläche, um weitere Pfade hinzuzufügen 
bzw. auf die Remove Row-Schaltfläche, um Pfade 
zu entfernen.

Move Row-Symbol. – um die Anordnung von 
Pfaden zu ändern, klicken Sie auf dieses Symbol 
und ziehen Sie es nach oben oder nach unten.

Um den letzten Pfad im New Path-Dialogfeld 
zu entfernen, drücken Sie bei gedrückter 
Befehls- (Mac) bzw. Strg-Taste (Windows) 
die Minustaste.

Wenn Sie einen neuen Ausgangspfad 
erstellen, wird automatisch ein Ausgangsbus 
auf der Bus-Registerkarte des I/O Setup-
Dialogfelds erstellt und dem erstellten 
Ausgangspfad zugewiesen. Siehe 
„Ausgangsbusse“ auf Seite 96.

Informationen zu Mehrkanalpfaden und -
Mischung finden Sie unter Kapitel 47: 
„Surround-Setup“.

New Paths-Dialogfeld

Move Row-Symbol im New Paths-Dialogfeld

Anzahl der neuen Pfade

Pfadformat Pfadname

Add/Remove Row 
(Zeile hinzufügen/entfernen)
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Add Default Channel 
Assignments-Option
Aktivieren Sie die Option Add Default Channel 

Assignments, so weist Pro Tools Eingänge, 
Ausgänge und Insert-Pfade automatisch 
physikalischen Ein- und Ausgängen in der Matrix 
zu (beginnend mit dem ersten verfügbaren Kanal 
bis zum Maximum der verfügbaren Kanäle). 
Übersteigt die Kanalanzahl der neuen Pfade die 
Anzahl der verfügbaren Kanäle, zählt Pro Tools ab 
Kanal 1 weiter. 

Auto-Create Sub-Paths-Option
Aktivieren Sie für Eingangs-, Bus- und Insertpfade 
die Option Auto Create Sub-Paths, erstellt 
Pro Tools wie folgt automatisch ein Standardset 
von Nebenpfaden für das angegebene 
Pfadformat (Kanalanzahl):

Standard-Nebenpfade

Hauptpfad Nebenpfade Nebenpfadname

Mono – –

Stereo 2 Mono Stereo: 
<Hauptpfadname> 
gefolgt von 
Kanalangabe .L und 
.R

LCR 1 Stereo (LR), 
3 Mono 
(1 pro Kanal)

Stereo: 
<Hauptpfadname>
.LR
Mono: 
<Hauptpfadname> 
.L, .C, .R

LCRS 1 Stereo (LR), 
4 Mono 
(1 pro Kanal)

Stereo: 
<Hauptpfadname> 
.LR
Mono: 
<Hauptpfadname>.
L, .C, .R, .S

Quad 1 Stereo (LR), 
4 Mono 
(1 pro Kanal)

Stereo: 
<Hauptpfadname> 
.LR
Mono: 
<Hauptpfadname>.
L, .R, .Ls, .Rs

5.0 – 
6.0 – 
7.0

1 Stereo (LR), 
5–7 Mono 
(1 pro Kanal)

Stereo: 
<Hauptpfadname>
.LR
Mono: 
<Hauptpfadname>
.L, .C, .R, .Ls, .Rs 
usw.

5.1 – 
6.1 – 
7.1

1 Stereo (LR), 
6–8 Mono 
(1 pro Kanal)

Stereo: 
<Hauptpfadname>
.LR
Mono: 
<Hauptpfadname>
.L, .C, .R, .Ls, .Rs 
usw. und LFE

Standard-Nebenpfade

Hauptpfad Nebenpfade Nebenpfadname
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Erstellen neuer Nebenpfade
Nebenpfade für Hauptpfade können Sie auf der 
Input-, Bus- und der Insert-Registerkarte des 
I/O Setup-Dialogfelds erstellen.

So erstellen Sie einen neuen Nebenpfad:

1 Öffnen Sie die Registerkarte des I/O Setup-
Dialogfelds, auf der Sie Nebenpfade erstellen 
möchten (etwa die Input-Registerkarte).

2 Wählen Sie den Hauptpfad, für den Sie neue 
Nebenpfade erstellen wollen.

3 Klicken Sie auf New Sub-Path.

4 Benennen Sie den neuen Nebenpfad.

5 Wählen Sie ein Format für den neuen 
Nebenpfad (etwa Mono).

6 Klicken Sie in die Matrix, um vorhandenen 
Hauptpfaden Nebenpfade zuzuweisen.

Bearbeiten von Pfaden
Im I/O Setup-Dialogfeld können Sie Definitionen 
für Signalpfade bearbeiten oder anpassen. 

Sie können Pfade:

• auf die Standardkonfiguration zurücksetzen

• umbenennen, um diese nach dem Wechseln oder 
Umbenennen von Audio-Interfaces leichter 
finden zu können

• auswählen und neu anordnen, um die Menü-
Reihenfolge in den Track-Selektor-Menüs 
zu ändern

• auswählen und löschen

• mit verschiedenen Quellen oder Zielen verknüpfen

• deaktivieren (bzw. reaktivieren), um nicht 
verfügbare oder nicht benötigte I/O-Ressourcen 
zu verwalten

Außerdem können Sie Ihre I/O Setup-
Konfigurationen als I/O-Einstellungsdateien 
importieren und exportieren sowie Standardpfad-
parameter festlegen. Siehe „I/O-Einstellungsdateien“ 
auf Seite 101.

In der folgenden Tabelle sind die für die einzelnen 
Pfadtypen verfügbaren Pfadattribute aufgelistet.

Interfaces können ebenfalls umbenannt werden.

Auf der Output-Registerkarte des I/O Setup-
Dialogfelds können Sie keine Nebenpfade 
für Ausgänge erstellen. Sie können jedoch 
sich überschneidende Pfade erstellen. 

Pfad-Optionen können pro Typ bearbeitet werden.

Pfadtyp Pfadoptionen (Attribute)

Input Namen, Formate und Quellkanal 
(physikalischer Eingang)

Output Namen, Formate und Zielkanal 
(physikalischer Ausgang)

Insert Namen, Formate und Ziel 
(physikalischer Ein- und Ausgang)

Bus Namen, Formate und 
Ausgangszuweisung
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Wiederherstellen von 
Standardpfaden und Pfadnamen
Sie können jederzeit den Standardzustand eines 
I/O-Setup-Pfads wiederherstellen. Beim Ersetzen 
oder Hinzufügen eines Audio-Interface ist es 
beispielsweise sinnvoll, die Standardeinstellungen 
wiederherzustellen. 

So stellen Sie Standardpfade und Pfadnamen 
wieder her:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die Input-, Output-, Insert- oder 
Bus-Registerkarte, um den entsprechenden 
Pfadtyp anzuzeigen.

3 Klicken Sie auf Default. Pro Tools reagiert 
wie folgt:

• Ist eine Session geöffnet, werden alle nicht 
verwendeten Pfade gelöscht.

• Es werden neue Standardpfade erstellt. Die Anzahl 
ist von den in Ihrem System verfügbaren 
physikalischen Anschlüssen abhängig. 

• Die Pfadnamen werden auf die 
Standardpfadnamen zurückgesetzt (siehe 
„Standardpfadnamen“ auf Seite 92). Diese 
Standardpfadnamen werden über die Input- und 
Output-Selektoren für die Spuren angezeigt.

4 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Umbenennen von Pfaden
Pfadnamen können im I/O Setup-Dialogfeld 
angepasst werden.

So benennen Sie einen Pfad im I/O Setup-
Dialogfeld um:

1 Doppelklicken Sie auf den Pfadnamen.

2 Geben Sie einen neuen Pfadnamen ein.

3 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Umbenennen von Interfaces 

Audio-Interfaces können im IO Setup-
Dialogfeld umbenannt werden. Wenn Sie 
Avid HD-Audio-Interfaces umbenennen, 
werden die Standardpfadnamen anhand der 
für das jeweilige Interface vergebenen 
anwenderdefinierten Namen bestimmt.

Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die Default-
Schaltfläche, um die Standardeinstellungen 
für alle Registerkarten des I/O Setup-
Dialogfelds wiederherzustellen.

Standard-Stereoausgangspfade

Es ist auch möglich, I/O-Pfade direkt im Edit- 
oder Mix-Fenster umzubenennen, indem Sie 
mit der rechten Maustaste auf den Selektor für 
Eingang oder Ausgang klicken und dann 
„Rename“ auswählen.

Neuer Mono-Eingangsnebenpfad für Hauptpfad A 1-2



Pro Tools-Referenzhandbuch92

So benennen Sie ein Audio-Interface im I/O Setup-
Dialogfeld um:

1 Doppelklicken Sie auf die Bezeichnung 
oberhalb des Interface.

2 Geben Sie einen neuen Interface-Namen ein.

3 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Standardpfadnamen

Standardnamen für Eingangs-, Ausgangs- und 
Insert-Pfade sind vom verwendeten Hardware-
Interface abhängig. 

Bei Avid HDX- und HD Native-Systemen 
werden die Standardpfadnamen nach den 
Namen der verwendeten Interfaces benannt. 
Wenn Sie Ihr Interface umbenannt haben, 
basieren die Standardpfadnamen auf dem 
anwenderdefinierten Namen.

Auswählen von Pfaden
Sie können im I/O Setup-Dialogfeld in der Spalte mit 
den Pfadnamen einzelne oder mehrere Pfade 
auswählen. Die ausgewählten Pfade und Nebenpfade 
können in der Spalte mit den Pfadnamen nach 
oben bzw. unten verschoben werden, um die 
Menüreihenfolge in den Track-Selektor-Menüs für 
Eingang, Ausgang, Insert und Bus zu ändern. Sie 
können Pfade auch löschen. Beim Verschieben von 
Hauptpfaden im I/O Setup-Dialogfeld werden auch 
die dazugehörigen Nebenpfade entsprechend 
verschoben.

So wählen Sie einen Haupt- oder Nebenpfad aus:

 Klicken Sie auf den Pfadnamen.

So wählen Sie mehrere Pfade gleichzeitig aus:

1 Klicken Sie auf den Pfadnamen.

2 Klicken Sie bei gedrückter Umschalttaste auf 
den Namen eines weiteren Pfads.

Alle Pfade zwischen dem ersten und dem letzten 
ausgewählten Pfadnamen werden nun ebenfalls 
ausgewählt.

Führen Sie einen der folgenden Schritte aus, 
um nicht benachbarte Pfade auszuwählen oder 
die Auswahl aufzuheben:

 Klicken Sie bei gedrückter Befehlstaste (Mac) 
bzw. Strg-Taste (Windows) auf nicht markierte 
Pfadnamen, um diese auszuwählen.

 Klicken Sie bei gedrückter Befehlstaste (Mac) 
bzw. Strg-Taste (Windows) auf markierte 
Pfadnamen, um die Auswahl aufzuheben.

So wählen Sie alle Pfade und Nebenpfade aus:

 Klicken Sie bei gedrückter Wahltaste (Mac) 
bzw. Alt-Taste (Windows) auf einen beliebigen 
nicht markierten Pfadnamen.

So heben Sie die Auswahl aller Pfade und 
Nebenpfade auf:

 Klicken Sie bei gedrückter Wahltaste 
(Mac) bzw. Alt-Taste (Windows) auf die 
markierten Pfadnamen.

Interface-Namen

Auswählen von Pfaden im I/O Setup-Dialogfeld
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Verschieben von Pfaden
Die ausgewählten Haupt- und Nebenpfade können 
in der Spalte mit den Pfadnamen nach oben bzw. 
unten verschoben werden, um die Menüreihenfolge 
in den Track-Selektor-Menüs für Eingang, 
Ausgang, Insert und Bus zu ändern.

So verschieben Sie Pfade im I/O Setup-Dialogfeld 
und in den Track-Selektoren:

1 Ziehen Sie die ausgewählten Pfadnamen nach 
oben oder unten.

2 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Löschen von Pfaden
Sie können Pfaddefinitionen aus Ihrer 
aktuellen Session löschen, um Änderungen in 
Ihrem Hardware-Setup Rechnung zu tragen oder 
unerwünschte oder nicht benötigte Pfaddefinitionen 
aus Track-Selektor-Menüs zu entfernen. Nach 
dem Löschen eines Pfads werden alle damit 
verknüpften Spur- oder Send-Zuweisungen auf 
No Output zurückgesetzt.

So löschen Sie einen Haupt- oder Nebenpfad:

1 Wählen Sie im I/O Setup-Dialogfeld den zu 
löschenden Pfad aus.

2 Klicken Sie auf Delete Path. 

3 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

So löschen Sie alle Pfade:

1 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf einen Pfadnamen.

2 Klicken Sie auf Delete Path.

3 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Aktivieren bzw. Deaktivieren 
von Pfaden
Pro Tools-Pfade können aktiv (eingeschaltet) oder 
inaktiv (ausgeschaltet oder nicht verfügbar) sein. 
Sie können Pfade im I/O Setup-Dialogfeld global 
aktivieren oder deaktivieren. Wenn Sie einen 
Signalpfad auf inaktiv setzen, wird dieser auf 
allen Spuren, denen er derzeit zugewiesen ist, 
ausgeschaltet.

Pro Tools deaktiviert auch nicht verfügbare Pfade. 
Manche Pfade stehen nicht mehr zur Verfügung, 
wenn Hardware- oder andere Systemressourcen 
nicht verfügbar sind, etwa beim Öffnen einer 
Session, die zuletzt in einem anderen System 
gespeichert wurde.

Auch Spuren können aktiv oder inaktiv sein. 
Informationen dazu finden Sie unter „Deaktivieren 
von Spureingängen und -ausgängen im Edit-oder 
Mix-Fenster“ auf Seite 239.

So aktivieren oder deaktivieren Sie einen 
Pfad global:

1 Wählen Sie Setup > I/O. 

2 Wählen Sie mithilfe der Registerkarten im 
oberen Bereich des Fensters einen Pfadtyp aus. 

3 Stellen Sie die Pfadeinstellung auf „Active“ 
bzw. „Inactive“. 

Bei Spuren, die einem jetzt inaktiven Pfad 
zugewiesen sind, wird der Pfadname in den I/O-
Selektor-Menüs der Spur kursiv dargestellt.

Einstellungen für aktive (oben) und inaktive 
(unten) Pfade
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4 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen. Der Pfad-Status wird wie 
folgt angezeigt:

Kursiv. – zeigt an, dass der Pfad inaktiv ist.

Nicht kursiv. – zeigt an, dass der Pfad aktiv ist.

Zuweisung von Kanälen zu 
Hardware-Ein- und Ausgängen
Pfade werden bestimmten Eingängen, 
Ausgängen und Inserts in der Matrix zugewiesen. 
Pfade können jederzeit bestimmten physikalischen 
Ein-und Ausgängen in der Matrix (neu) 
zugewiesen werden.

So weisen Sie Kanäle zu:

1 Wählen Sie einen Haupt oder Nebenpfad aus 
oder erstellen Sie ihn. 

2 Wählen Sie das Kanalformat aus (etwa Stereo).

3 Klicken Sie in der Zeile für den ausgewählten 
Pfad auf die Matrixspalte unterhalb eines 
Audio-Interface und Kanals. 

Gegebenenfalls vorhandene andere Kanäle für diesen 
Pfadtyp werden rechts davon ausgefüllt. Wenn Sie 
etwa beim Zuweisen eines neuen Stereopfads in der 
Zeile für den Pfad unter den Ausgangskanal 1 
klicken, werden sowohl Kanal 1 als auch Kanal 2 
(links von 1, rechts von 2) aktiviert. 

4 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Falls Einstellungen miteinander in Konflikt stehen 
oder ungültig sind, müssen Sie diese korrigieren, 
bevor Sie das I/O Setup-Dialogfeld schließen 
können. Weitere Informationen finden Sie 
unter „Gültige Pfade und Voraussetzungen“ auf 
Seite 95.

Zuweisen von Kanälen zum Surround-Mixer

(Nur Pro Tools HD)

Beim Zuweisen von Mehrkanalpfaden wird der 
linke Kanal (L) dem ersten aktivierten Kästchen 
in der Matrix zugewiesen. Die restlichen Kanäle 
werden rechts davon entsprechend der 
Standardpfadanordnung eingetragen. 

Da einige Mehrkanal-Mischformate eigene 
Spuranordnungen verwenden, können Sie in 
Pro Tools das Standardformat im I/O Setup-
Dialogfeld festlegen (siehe „I/O Setup-Optionen“ 
auf Seite 77).

Wird im Falle sich überschneidender 
Ausgangspfade mit unterschiedlicher 
Kanalanzahl der Pfad mit der höchsten 
Kanalanzahl deaktiviert, so werden aus allen 
übrigen sich überschneidenden 
Ausgangspfaden keine Audiosignale aus 
Pro Tools gesendet.

Zuweisen von Kanälen

Informationen zum Zuweisen von 
Kanälen in einem Pfad finden Sie unter 
„Neuzuweisen von Kanälen“ auf 
Seite 95.

5.1 Path Order-Einstellung
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Neuzuweisen von Kanälen
Sie können einzelne Zuweisungen auf andere 
Kanäle verschieben, um den Pfad neu zu 
definieren (etwa zum Ändern einer 
Mehrkanalanordnung in L-R-C-LFE-Ls-Rs). 

So nehmen Sie eine Neuzuweisung von Kanälen in 
einem Pfad vor:

 Ziehen Sie den Kanal an die neue Stelle in der 
Matrix. Andere Kanalzuweisungen werden 
dabei verschoben, um den eingefügten Kanälen 
Platz zu machen.

Verschieben von Kanälen

Wenn Sie einen Signalpfad von rechts nach links 
verschieben, werden die anderen Signalpfade 
hinter dem neuen Zielkanal neu angeordnet. 
Wenn Sie einen Signalpfad von links nach rechts 
verschieben, werden alle Signalpfade hinter dem 
neuen Zielkanal neu geordnet und der vorherige 
Kanal bleibt leer. 

Nebenpfade richten sich 
nach Hauptpfaden

Wenn ein Hauptpfad neu zugewiesen wird, werden 
auch vorhandene dazugehörige Nebenpfade 
automatisch neu zugewiesen, um ein einheitliches 
Routing zu gewährleisten. Wenn Sie 
beispielsweise einen Stereopfad anderen 
Hardware-Ausgängen zuweisen, werden auch alle 
seine Nebenpfade mit verschoben. 

Gültige Pfade und 
Voraussetzungen
Beim Konfigurieren des I/O Setup-Dialogfelds 
gelten bestimmte Regeln für Pfaddefinitionen 
und Kanalzuweisungen. Damit die I/O Setup-
Konfiguration eingesetzt werden kann, müssen 
alle Pfade gültig sein. 

Sie können in der Kanalmatrix zwar ungültige 
Zuweisungen erstellen, Pro Tools akzeptiert 
eine I/O Setup-Konfiguration jedoch erst, 
wenn alle Pfade den unten beschriebenen 
Anforderungen für Pfa ddefinitionen und 
Kanalzuweisungen entsprechen.

Mindestanforderungen für die Pfaddefinition. – 
alle Pfade müssen über einen Namen, 
ein bestimmtes Format und eine gültige I/O-
Zuweisung verfügen. 

Gültige Pfade. – beim Zuweisen von 
Kanälen müssen im Zusammenhang mit sich 
überschneidenden Pfaden bestimmte Regeln 
eingehalten werden. 

• Es darf keine teilweise Überschneidung 
zwischen Ausgangspfaden bestehen.

• Ein neu erstellter Ausgangspfad muss 
entweder vollkommen unabhängig von 
anderen Zuweisungen sein (nicht anderen 
I/O-Interfaces/Kanälen zugewiesen) oder 
als Nebenpfad vollständig in einem 
Hauptpfad enthalten sein (etwa als LCR-
Nebenpfad innerhalb eines 5.1-Pfads).

Wenn das Format eines Pfads geändert 
wird, werden alle aktuellen 
Kanalzuweisungen gelöscht. 

Gültige (vollständige) Ausgangspfade
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Konfigurieren von Bussen
Busse werden auf der Bus-Registerkarte des I/O 
Setup-Dialogfelds angezeigt. Pro Tools verfügt 
über zwei Arten von Bussen:

• Ausgangsbusse

• interne Mixbusse

Einstellungen von Ausgangsbussen und internen 
Mixbussen werden gemeinsam mit der Session 
gespeichert und wieder abgerufen. Dies ist 
von Vorteil, wenn Sie eine Session auf 
unterschiedlichen Systemen bearbeiten, da Spur- 
und Send-Zuweisungen für die Session beibehalten 
werden. Soweit möglich weist Pro Tools kann die 
Ausgangsbusse einer Session automatisch den 
Ausgangspfaden des Systems, auf dem die Session 
geöffnet wird, neu zu.

Ausgangsbusse
Ausgangsbusse können Ausgangspfaden 
zugewiesen werden (entsprechend der 
Konfiguration auf der Output-Registerkarte 
des I/O Setup-Dialogfelds). Danach werden 
die Ausgangspfade in der I/O-Setup-Matrix den 
physikalischen Audioausgängen des Systems 
zugewiesen (siehe „Zuweisung von Kanälen zu 
Hardware-Ein- und Ausgängen“ auf Seite 94).

Wenn Sie auf der Output-Registerkarte des I/O 
Setup-Dialogfelds einen neuen Ausgangspfad 
erstellen, wird automatisch ein neuer Ausgangsbus 
mit derselben Kanalanzahl erstellt und dem 
Ausgangspfad zugewiesen. Ausgangsbusse 
werden beim Erstellen einer neuen Session oder 
beim Wiederherstellen der Standardeinstellungen 
entsprechend der Standardeinstellungen erstellt 
und zugewiesen (siehe „Wiederherstellen von 
Standardpfaden und Pfadnamen“ auf Seite 91).

Die physikalischen Ausgänge der Ausgangspfade 
werden auf der Output-Registerkarte des I/O 
Setup-Dialogfelds konfiguriert (siehe „Zuweisung 
von Kanälen zu Hardware-Ein- und Ausgängen“ 
auf Seite 94).

Interne Mixbusse 
Pro Tools bietet bis zu 256 interne Mixbusse, 
die verwendet werden können, um das Audiosignal 
von Spurausgängen und -Sends auf Spureingänge 
und Plug-In-Sidechains zu routen. Häufig werden 
interne Mixbusse als Effekt-Sends und -Returns 
verwendet (etwa von einer Audiospur auf 
eine Auxiliary-Eingangs-Spur zur Plug-In-
Effektverarbeitung) und zur Bus-Aufnahme.

Interne Mixbusse können auch beliebigen 
Ausgängen zugewiesen werden (siehe „Interne 
Mixbusse“ auf Seite 96).

Ungültige (unvollständige) Ausgangspfade

Weitere Informationen zur Verwendung von 
Sessions auf unterschiedlichen Systemen 
und dem Öffnen von Sessions mit älteren 
Pro Tools-Versionen finden Sie unter 
„Session-Austausch“ auf Seite 103. 
Ausgangsbusse sind in Pro Tools 8.0.x 
und niedriger nicht verfügbar. 
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Erstellen von Bussen und 
Zuweisen zu Ausgängen
Verfügbare Busse können verfügbaren 
Ausgangspfaden mit derselben oder einer höheren 
Kanalanzahl zugewiesen werden. Sie können 
etwa einen Monobus einem Mono-Ausgangspfad 
zuweisen, ein Stereobus kann einem Stereo-
Ausgangspfad und ein 5.1-Surroundbus kann 
einem 5.1-Surround-Ausgangspfad 
zugewiesen werden.

Sie können die Zuweisung von Bussen und 
Ausgängen jederzeit aufheben.

So erstellen Sie einen Bus und weisen ihn einem 
Ausgangspfad zu:

1 Klicken Sie auf der Bus-Registerkarte 
des I/O Setup-Dialogfelds auf die New 

Path-Schaltfläche.

2 Geben Sie im New Paths-Dialogfeld die Anzahl 
der neu zu erstellenden Pfade, die Kanalanzahl 
für jeden Pfad und die Pfadnamen an.

3 Klicken Sie auf zum Erstellen neuer Pfade 
auf Create.

4 Aktivieren Sie „Mapping To Output“ für 
den Ausgangspfad.

5 Wählen Sie über den Mapping To Output-
Selektor einen Ausgangspfad aus.

Alle Signale, die aus Spuren oder Sends an 
den Bus geleitet wurden, werden jetzt and die 
den Ausgangspfaden zugewiesenen Hardware-
Ausgänge geleitet.

So weisen Sie alle Ausgangsbusse mit 
identischem Format einem Ausgangspfad zu:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf den Mapping to 
Output-Selektor und wählen Sie einen 
Ausgangspfad (Mono oder Stereo) aus.

Alle zugewiesenen Ausgangsbusse desselben 
Formats (etwa Stereo) werden demselben 
Ausgangspfad zugewiesen. Sie können etwa 
alle Stereo-Ausgangsbusse dem Ausgangspfad 
A 1–2 zuweisen.

So weisen Sie alle Ausgangsbusse mit 
identischem Format einem einzigen 
Ausgangspfad zu.

1 Sie haben folgende Möglichkeiten:

• Klicken Sie bei gedrückter Umschalttaste, 
um nebeneinanderliegende 
Ausgangsbusse auszuwählen.

• Klicken Sie bei gedrückter Strg- (Windows) bzw. 
Befehlstaste (Mac), um nicht nebeneinander 
liegende Ausgangsbusse auszuwählen.

New Paths-Dialogfeld

Entfernen der Zuweisung des MAIN-Ausgangsbusses

Zuweisen des „MAIN“-Ausgangsbusses an den 
Ausgangspfad „A 1–2“



Pro Tools-Referenzhandbuch98

2 Klicken Sie bei gedrückter Wahl- und 
Umschalttaste (Mac) bzw. Alt- und Umschalttaste 
(Windows) auf den Mapping to Output-Selektor 
eines der ausgewählten Ausgangsbusse 
und wählen Sie einen Ausgangspfad 
(Mono oder Stereo). 

Nur die ausgewählten zugewiesenen 
Ausgangsbusse desselben Formats (etwa Stereo) 
können demselben Ausgangspfad zugewiesen 
werden. Sie können etwa nur die ausgewählten 
Stereo-Ausgangsbusse dem Ausgangspfad 
A 1–2 zuweisen.

So weisen Sie alle Busse mit identischem Format 
in aufsteigender Reihenfolge eindeutigen 
Ausgangspfaden zu:

 Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) bzw. Strg- und Alt-Taste 
(Windows) auf den Mapping to Output-Selektor 
des obersten Ausgangspfads und wählen Sie 
den ersten Ausgangspfad. 

Alle Busse mit demselben Kanalformat werden 
automatisch in aufsteigender Reihenfolge 
eindeutigen Ausgangspfaden zugewiesen. 
Bei Stereo-Ausgangspfaden wird etwa der 
Ausgangsbus A 1–2 dem Ausgangspfad A 1–2, der 
Ausgangsbus A 3–4 dem Ausgangspfad A 3–4 und 
der Ausgangsbus A 5–6 dem Ausgangspfad A 5–6 
zugewiesen usw.

Zuweisen von Monobussen zu 
Surround-Pfaden
(Nur Pro Tools HD)

Sie können Monobusse dem Kanal eines 
beliebigen Surround-Ausgangspfads zuweisen, 
indem Sie zum Beispiel eine Dialogspur auf den 
mittleren Kanal des 5.1-Ausgangspfads routen. 
(Diese Möglichkeit besteht für alle 
Ausgangskanalformate außer Stereo und Quad.)

So können Sie dem Kanal eines Surround-
Ausgangspfads einen Monobus zuweisen:

1 Klicken Sie auf der Bus-Registerkarte 
des I/O Setup-Dialogfelds auf die New 

Path-Schaltfläche.

2 Legen Sie im New Paths-Dialogfeld das Mono-
Kanalformat für den Buspfad fest, geben Sie 
einen Namen für den Pfad ein und klicken Sie 
auf Create.

3 Aktivieren Sie „Mapping To Output“ für 
den Ausgangspfad.

4 Wählen Sie über den Mapping To Output-
Selektor den gewünschten Mehrkanal-
Ausgangspfad. Die Monobus-Anzeige verändert 
sich standardmäßig zu „C“ (für Center) und ein 
Popup-Menü wird geöffnet.

5 Klicken Sie auf die Monobus-Anzeige und 
wählen Sie einen Kanal aus dem Popup-Menü 
aus, um weitere Kanäle zuzuweisen.

So weisen Sie sämtlichen Monobussen, 
die einem bestimmten Mehrkanal-Ausgangspfad 
zugewiesen sind, denselben Kanal zu:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf die Monobus-Anzeige 
und wählen Sie den Kanal aus dem Popup-
Menü aus. 

Auswählen eines Mehrkanal-Ausgangspfads

Zuweisen eines Kanals zu einem Monobus
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So weisen Sie sämtlichen, ausgewählten 
Monobussen, die einem bestimmten Mehrkanal-
Ausgangspfad zugewiesen sind, denselben 
Kanal zu:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie bei gedrückter Umschalttaste in die 
Spalte mit den Pfadnamen, um nebeneinander-
liegende Monobusse auszuwählen.

• Klicken Sie bei gedrückter Befehls- (Mac) bzw. 
Strg-Taste (Windows) in der Name-Spalte, 
um nicht nebeneinander liegende 
Monobusse auszuwählen.

2 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) und Umschalttaste auf die 
Monobus-Anzeige und wählen Sie den Kanal 
aus dem Popup-Menü aus. 

So weisen Sie sämtlichen Monobussen, 
die einem bestimmten Mehrkanal-Ausgangspfad 
zugewiesen sind, Kanäle in aufsteigender 
Reihenfolge zu:

 Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) bzw. Strg- und Alt-Taste 
(Windows) auf die oberste Monobus-Anzeige 
und wählen Sie den ersten Kanal aus dem 
Popup-Menü aus. 

So weisen Sie sämtlichen ausgewählten 
Monobussen, die einem bestimmten Mehrkanal-
Ausgangspfad zugewiesen sind, Kanäle in 
aufsteigender Reihenfolge zu:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie bei gedrückter Umschalttaste in die 
Spalte mit den Pfadnamen, um nebeneinander-
liegende Monobusse auszuwählen.

• Klicken Sie bei gedrückter Befehls- (Mac) 
bzw. Strg-Taste (Windows) in der Name-
Spalte, um nicht nebeneinander liegende 
Monobusse auszuwählen.

2 Klicken Sie bei gedrückter Befehls-, Wahl- und 
Umschalttaste (Mac) bzw. Strg-, Alt- und 
Umschalttaste (Windows) auf die oberste 
Monobus-Anzeige und wählen Sie den ersten 
Kanal aus dem Popup-Menü aus. 

Zurücksetzen von Bussen
Sie können die Anzahl der verfügbaren internen 
Mixbusse in Ihrer Session entsprechend der 
Leistungsfähigkeit Ihres Systems einstellen, 
indem Sie sie auf die Standard-
Buskonfiguration zurücksetzen.

So stellen Sie die Standard-Buskonfiguration für 
Ihr System wieder her:

1 Öffnen Sie das I/O Setup-Dialogfeld.

2 Klicken Sie in der linken oberen Ecke auf die 
Bus-Registerkarte.

3 Wählen Sie aus dem Popup-Menü rechts 
von der Default-Schaltfläche eine der 
folgenden Optionen:

• All Busses 

• Output Busses 

• Internal Busses 

4 Klicken Sie auf Default. 

5 Klicken Sie auf OK, um die Einstellungen 
zu speichern und das I/O Setup-Dialogfeld 
zu schließen.

Aktive Busse

Auf der Bus-Registerkarte des I/O Setup-
Dialogfelds wird die Anzahl der aktiven internen 
Mixbusse angezeigt. Wenn die Anzahl der aktiven 
Busse die Anzahl der verfügbaren Busse (256) 
übersteigt, wird die Anzeige rot dargestellt. 
Löschen oder deaktivieren Sie überzählige aktive 
Busse, um das I/O Setup-Dialogfeld schließen und 
Ihre Einstellungen speichern zu können.

Pro Tools erstellt standardmäßig 
128 interne Busse (von insgesamt 
256 möglichen). 

Das Zurücksetzen auf die Standarde-
instellung hat die Umbenennung aller 
Busse auf deren Standardnamen zur Folge 
(Bus 1–2, Bus 3–4 usw.).
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Sortieren von Buspfaden
Die Bus-Registerkarte verfügt über Einstellungen, 
mit deren Hilfe Busse nach Namen (auf- oder 
absteigend), das Format (auf- oder absteigend) 
oder der Status der Output-Zuweisung (nur 
aufsteigend) sortiert werden können.

So sortieren Sie Buspfade nach Namen:

1 Klicken Sie auf der Bus-Registerkarte auf den 
Spaltenkopf der Spalte mit den Pfadnamen.

2 Klicken Sie erneut auf den Spaltenkopf 
der Spalte mit den Pfadnamen, um zwischen 
auf- und absteigender Sortierreihenfolge 
zu wechseln.

So sortieren Sie Buspfade nach Format:

1 Klicken Sie auf der Bus-Registerkarte auf den 
Spaltenkopf der Format-Spalte. 

2 Klicken Sie nochmals auf den Spaltenkopf der 
Format-Spalte, um zwischen auf- und 
absteigender Sortierreihenfolge zu wechseln.

So sortieren Sie Buspfade nach Output-Zuweisung:

 Klicken Sie auf der Bus-Registerkarte auf den 
Spaltenkopf der Mapping to Output-Spalte. 

Werkseitige I/O-Einstellungen
Pro Tools bietet werkseitige I/O-Einstellungen 
für Stereo- und Surround-Mischungen, 
die automatisch zusammen mit Pro Tools 
installiert werden. Über diese Einstellungen 
sind Standardpfade und Nebenpfade für beide 
Mischformate in neuen Sessions verfügbar.

Werkseitige I/O-Einstellungen können auch im 
I/O Settings-Popup-Menü des Quick Start- und 
New Session-Dialogfelds ausgewählt werden.

Einstellungen für 
Stereomischungen
Bei Auswahl der Stereo Mix-Einstellung wird 
die maximale Anzahl an Stereopfaden erstellt, 
entsprechend den Festlegungen der jeweiligen I/O-
Einstellungen und der Hardwarekonfiguration 
des Systems.

Einstellungen für 
Surroundmischungen 
(Nur Pro Tools HD)

Die Surround Mix-Einstellung bietet zusätzliche 
surroundspezifische Dateien für Ausgangs- und 
Bus-Einstellungen. 

Ordnen von Bussen im I/O Setup-Dialogfeld

Zum Sortieren nach 
Format anklicken

Die Stereo Mix-Einstellungsdatei hat 
dieselbe Wirkung, als würden Sie auf 
jeder einzelnen Registerkarte der I/O-
Einstellungen auf „Default“ klicken. 
Siehe „Wiederherstellen von 
Standardpfaden und Pfadnamen“ auf 
Seite 91.

Siehe Kapitel 47: „Surround-Setup“.

Zum Sortieren nach 
Namen anklicken

Zum Sortieren nach Status 
der Output-Zuweisung 

anklicken
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I/O-Einstellungsdateien
I/O-Einstellungsdateien (PIO-Dateien) enthalten 
Standardkonfigurationen für neue Sessions. Die I/O-
Einstellungen können importiert und exportiert 
werden und so auf unterschiedlichen Systemen 
verwendet werden. I/O-Einstellungsdateien können 
auch im I/O Settings-Popup-Menü des Quick Start- 
und New Session-Dialogfelds ausgewählt werden.

Um I/O-Einstellungsdateien im Quick Start- und 
New Session-Dialogfeld auswählen zu können, 
müssen diese im IO Settings-Ordner des Root 
Settings-Ordners gespeichert sein: Sie können den 
Speicherort des Ordners „Root Settings“ unter 
„Operation Preferences“ ändern (siehe „User 
Library-Abschnitt“ auf Seite 110).

Zuletzt verwendete 
I/O-Einstellungen
Wenn während einer Session im I/O Setup-
Dialogfeld Änderungen vorgenommen wurden, 
werden diese beim Schließen des Dialogfelds 
(durch Klicken auf OK) in der Last Used-
Einstellungsdatei gespeichert.

Die zuletzt verwendeten I/O-Einstellungen können 
auch im I/O Settings-Popup-Menü des Quick 
Start- und New Session-Dialogfelds ausgewählt 
werden. Darüber hinaus sind sie auch beim 
Importieren von I/O-Einstellungen in das I/O-
Setup verfügbar.

Anwenderdefinierte 
I/O-Einstellungen
Erstellen Sie anwenderdefinierte I/O-
Einstellungsdateien, indem Sie die im I/O Setup 
geänderten Einstellungen exportieren (siehe 
„Anpassen der I/O-Einstellungen“ auf Seite 82). 
Diese I/O-Einstellungen werden durch einen 
Import auf einem System wiederhergestellt.

Dies dient zum Speichern von Einstellungen für 
verschiedene Projekte, zum Importieren von 
Einstellungen zur Neukonfiguration des I/O-
Setups und zum Verwalten von Pfaddefinitionen 
und Signal-Routing-Setups. 

Importieren von 
I/O-Einstellungen
Der Import von I/O-Einstellungen ist vor oder nach 
dem Öffnen einer Session möglich. Die I/O-
Einstellungen werden nur für die aktuell angezeigte 
Registerkarte des I/O Setup-Dialogfelds importiert. 
Wird etwa die Output-Registerkarte angezeigt und 
Sie führen einen Import der I/O-Einstellungen durch, 
werden nur die Einstellungen für die Output-
Registerkarte übernommen. Auf diese Weise bleiben 
Ihre anwenderdefinierten I/O-Einstellungen auf den 
übrigen Registerkarten intakt.

Beim Importieren von I/O-Einstellungen können Sie 
wählen, ob Sie nicht verwendete Pfaddefinitionen 
vor dem Importieren neuer Pfade löschen oder 
beibehalten und die neuen Pfade zur aktuellen I/O 
Setup-Konfiguration hinzufügen möchten.

Mit dem Import Session Data-Befehl 
(File > Import > Session Data) können Sie 
auch I/O-Pfade und Pfadnamen sowie 
andere Session-Daten aus einer anderen 
Session importieren. Informationen dazu 
finden Sie unter „Importieren von Session-
Daten“ auf Seite 346.
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So importieren Sie I/O-Einstellungen:

1 Klicken Sie auf die Registerkarte des I/O Setup-
Dialogfelds, für die Sie Einstellungen 
importieren möchten.

2 Klicken Sie auf Import Settings.

3 Wählen Sie im Import Settings-Dialogfeld 
eine I/O-Einstellungsdatei und klicken Sie 
auf Import.

4 Daraufhin wird ein Dialogfeld mit der Frage 
eingeblendet, ob Sie bestehende Pfade löschen 
möchten. Sie haben folgende Möglichkeiten:

• Klicken Sie auf Yes, um der aktuellen I/O-
Setup-Konfiguration die importierten Pfade 
hinzuzufügen und nicht verwendete Pfade 
zu löschen.

• Klicken Sie auf No, um der aktuellen I/O 
Setup-Konfiguration die importierten 
Pfade hinzuzufügen. 

Sollten die importierten Pfade zu Überschneidungen 
führen, werden die neuen Pfade im I/O-Setup 
als inaktiv angezeigt. Siehe „Aktivieren bzw. 
Deaktivieren von Pfaden“ auf Seite 93.

Nach dem Import von I/O-Einstellungen können 
Sie im I/O-Setup die Pfad-Routing-Definitionen 
neu zuweisen, indem Sie Pfade neu zuordnen, 
umbenennen oder löschen. Siehe „Pro Tools-
Signalpfade“ auf Seite 70.

Exportieren von 
I/O-Einstellungen
Beim Exportieren von I/O-Einstellungen 
werden alle Registerkarten des I/O Setup-
Dialogfelds exportiert.

So exportieren Sie eine I/O Setup-Konfiguration 
und speichern sie als anwenderdefinierte I/O-
Einstellungsdatei:

1 Konfigurieren Sie die I/O-Einstellungen.

2 Klicken Sie auf Export Settings. 

3 Benennen Sie die Einstellungsdatei und 
speichern Sie sie. Dem Namen der Session-
Datei wird automatisch die Erweiterung 
„.pio“ hinzugefügt.

Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die Import 
Settings-Schaltfläche, um die Einstellungen 
für alle Registerkarten des I/O Setup-
Dialogfelds zu importieren.

Um Sessions mit einem leeren I/O Setup-
Dialogfeld zu beginnen, können Sie eine I/O-
Einstellungsdatei erstellen und exportieren, 
in der alle Definitionen gelöscht wurden. 
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Session-Austausch
Wenn Sie Sessions auf unterschiedlichen 
Pro Tools-Systemen verwenden, müssen Sie 
möglicherweise die I/O-Einstellungen der Session 
neu konfigurieren. Dies ist abhängig von der 
System-ID, Pfadnamen und Pfadformaten sowie 
der Pro Tools-Versionen der Systeme, auf die die 
Session übertragen wird.

Pfadnamen und automatische 
Neuzuweisung der 
Ausgangsbusse
Eine System-ID wird für jeden Computer, auf dem 
die Session geöffnet wird, erstellt und in der 
Session gespeichert (dabei wird die MAC-Adresse 
des Computers verwendet). Findet Pro Tools eine 
bekannte System-ID beim Öffnen einer Session, 
werden die Ausgänge wieder hergestellt. Eine 
Neukonfiguration ist somit nicht nötig.

Wird eine Pro Tools-Session auf einem System 
zum ersten Mal geöffnet, versucht Pro Tools 
automatisch, die Ausgangsbusse neu zuzuweisen.

Findet Pro Tools keine bekannte System-ID, 
versucht das Programm automatisch die 
Ausgangsbusse nach den folgenden Kriterien 
neu zuzuweisen:

Pfadname und -Format. – Pfadnamen müssen 
identisch sein und das gleiche Format besitzen.

Nur Pfadformat. – können keine 
übereinstimmenden Pfadnamen gefunden werden, 
weist Pro Tools die Pfade vorhandenen Pfaden mit 
dem gleichen Format (Kanalanzahl) zu.

Ein Ausgangsbuspfad, der nicht automatisch 
zugewiesen werden kann, wird deaktiviert 
geöffnet. Sie müssen die Pfade aktiven 
Ausgangspfaden zuweisen.

Pro Tools-Versionen und 
Session-Austausch
Wird eine Session auf Systemen mit 
unterschiedlichen Pro Tools-Softwareversionen 
bearbeitet (Ihr Pro Tools 11.0-System und das 
Pro Tools 7.x-System eines Kollegen), können Sie 
die folgenden Vorgaben einhalten, um Pfade und 
Signalrouting beizubehalten.

Pro Tools 8.1 und höher

Wird eine Session auf Systemen mit Pro Tools 8.1 
oder höher geöffnet, empfehlen wir, die Option 
Sessions Overwrite Current I/O Setup When 

Opened zu deaktivieren. Dadurch werden die I/O-
Einstellungen des Systems beibehalten, wenn die 
Session auf einem anderen System geöffnet wird 
(siehe „Sessions Overwrite Current I/O Setup 
When Opened“ auf Seite 81).

Pro Tools 8.0.x und niedriger

Wird eine Session auf Systemen mit früheren 
Pro Tools-Versionen geöffnet, empfehlen wir, 
die Option Sessions Overwrite Current I/O Setup 

When Opened zu aktivieren (siehe „Sessions 
Overwrite Current I/O Setup When Opened“ auf 
Seite 81). In einem solchen Fall muss jede 
anwenderdefinierte Einstellung, die mit der Session 
gespeichert wurde und keine Übereinstimmung auf 
Ihrem System besitzt, manuell im I/O Setup-
Dialogfeld neu konfiguriert werden, um an die 
aktuelle Studiokonfiguration angepasst zu werden.

Wenn Sie ein Backup Ihrer I/O-Einstellungen 
erstellt haben, können Sie die Einstellungen 
nach dem Öffnen der Session importieren 
(siehe „Importieren von I/O-Einstellungen“ 
auf Seite 101).
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Öffnen älterer Sessions in Pro Tools 8.1 
und höher

Wenn Sie Sessions, die mit Pro Tools 8.0.x und 
niedriger erstellt wurden, in Pro Tools 8.1 oder 
höher öffnen, werden Ausgangspfade der alten 
Session als Ausgangsbusse neu angelegt. Wird 
die Option Sessions Overwrite Current I/O 

Setup When Opened aktiviert, werden die 
Ausgangsbusse den Ausgangspfaden der 
Session zugewiesen.

Pfadreihenfolge und sich 
überschneidende Pfade

Wenn Sie Sessions zwischen Systemen mit 
Pro Tools 8.1 oder höher und Pro Tools 8.0.x und 
niedriger austauschen, werden die Ausgangspfade 
und Nebenpfade wie nachfolgend beschrieben 
angepasst, abhängig von deren Reihenfolge im 
I/O-Setup.

 Enthält eine mit Pro Tools 8.1 oder höher 
erstellte Session Pfade, die sich im I/O-Setup mit 
einem umfangreicheren Pfad über kleineren 
Pfaden überschneiden, so werden die kleineren 
Pfade in Nebenpfade des umfangreicheren Pfads 
konvertiert, wenn die Session mit Pro Tools 8.0.x 
oder niedriger geöffnet wird.

 Enthält eine mit Pro Tools 8.1 oder höher 
erstellte Session sich überschneidende Pfade, bei 
denen im I/O-Setup ein kleinerer Pfad über einem 
umfangreicheren erscheint, so wird der 
umfangreichere Pfad deaktiviert, wenn die Session 
mit Pro Tools 8.0.x oder niedriger geöffnet wird.

Letztes gespeichertes und 
aktuelles Setup anzeigen
Beim Öffnen einer Session mit Pfaddefinitionen 
für nicht verfügbare I/O-Module werden diese 
Pfade im I/O Setup-Dialogfeld kursiv angezeigt. 

Klicken Sie auf die Show Last Saved Setup-
Schaltfläche, um die in der ursprünglichen Session 
genutzten Audio-Interfaces anzuzeigen. Über 
diese kurzzeitige Anzeige können Sie die zuletzt 
gespeicherte I/O-Konfiguration als Referenz 
anzeigen, während Sie die I/O-Einstellungen für 
Ihr System konfigurieren. 

Nachdem Sie eine Session mit nicht verfügbaren 
I/O geöffnet haben, können Sie Spuren 
verfügbaren I/O-Pfaden neu zuweisen. 

Hat sich Ihre Hardware-Konfiguration 
geändert, müssen Sie die Zuweisungen der 
Ausgänge gegebenenfalls auf der Output-
Registerkarte des I/O Setup-Dialogfelds neu 
konfigurieren. Siehe „Zuweisung von 
Kanälen zu Hardware-Ein- und Ausgängen“ 
auf Seite 94.
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Kapitel 8: Preferences

Die Einstellungen in den Pro Tools Preferences 
definieren, wie Pro Tools-Funktionen eingesetzt 
werden. Das Preferences-Dialogfeld verfügt über 
mehrere Registerkarten, auf denen Sie Ihre 
bevorzugten Einstellungen festlegen können.

So ändern Sie die Pro Tools-Voreinstellungen:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Registerkarte für die 
Voreinstellung, die Sie ändern möchten. 

3 Ändern Sie die Voreinstellungen.

4 Klicken Sie auf OK, um die Änderungen 
zu speichern und das Preferences-Dialogfeld 
zu schließen.

Anzeige-Voreinstellungen 
(Display)

Basics-Abschnitt
Track Position Numbers Stay with Hidden 
Tracks. – wenn diese Option aktiviert ist, behalten 
alle Spuren ihre Spurnummer bei, auch wenn sie 
ausgeblendet sind. Andernfalls werden nur 
eingeblendeten Spuren Nummern zugewiesen. 
In diesem Fall werden eingeblendete Spuren 
fortlaufend nummeriert, ausgeblendete verfügen 
über keine Nummerierung.
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QuickInfo-Anzeigeoptionen

Funktion. – mit dieser Option wird die Funktion des 
jeweiligen Elements in der QuickInfo angezeigt.

Details. – mit dieser Option werden normalerweise 
abgekürzte Namen oder Bezeichnungen von 
Elementen (etwa ein Spurname) vollständig 
in der QuickInfo angezeigt. Hier können auch 
ausgeblendete oder abgekürzte Werte von 
Parametern sowie Eingangs- und 
Ausgangszuweisungen angezeigt werden. 

Standardlänge des Edit-Fensters

Mit dieser Voreinstellung können Sie für das Edit-
Fenster eine Standardlänge in Stunden, Minuten, 
Sekunden und Frames einstellen. Diese Funktion ist 
besonders dann nützlich, wenn Sie eine Session mit 
einer bestimmten Länge zusammenstellen oder aber 
zusätzlichen Platz haben möchten, um für die 
Session den Arbeitsbereich im Edit-Fenster zu 
vergrößern. Die maximal mögliche Dauer beträgt 
24 Stunden. Zur Erreichung einer optimalen 
Empfindlichkeit der Bildlaufleiste stellen Sie diesen 
Wert etwas höher ein (um eine Minute oder mehr) 
als die Dauer der Gesamt-Session oder des Songs.

Organize Plug-In Menus By-Optionen

Mit diesen Optionen können Sie festlegen, 
wie Plug-In-Menüs des Insert- oder Plug-In-
Selektors angeordnet sind.

Flat List. – zeigt die Plug-Ins in einer einzigen 
Liste in alphabetischer Reihenfolge an.

Kategorie. – organisiert die Plug-Ins nach 
Bearbeitungskategorie (wie etwa „EQ“, 
„Dynamics“ oder „Delay“). Dabei werden die 
einzelnen Plug-Ins in den Untermenüs für die 
Kategorien aufgeführt. Plug-Ins, die sich keiner 
Standardkategorie zuordnen lassen (wie etwa 
Signal Generator), oder Plug-Ins anderer 
Hersteller, denen vom jeweiligen Hersteller keine 
Kategorie zugeordnet wurde, werden der Other-
Kategorie unterstellt. Plug-Ins können mehr als 
einer Kategorie angehören. 

Manufacturer. – organisiert die Plug-Ins nach 
dem Hersteller (beispielsweise Bomb Factory, 
Focusrite oder TL Labs). Dabei werden die 
einzelnen Plug-Ins in den Untermenüs für die 
Hersteller aufgeführt. Plug-Ins, für die kein 
Hersteller festgelegt ist, werden im Other-Ordner 
für die Hersteller aufgeführt. 

Category und Manufacturer. – organisiert Plug-Ins 
in zwei Menüebenen. In der oberen Menüebene 
werden die Plug-Ins nach Bearbeitungskategorie 
(wie etwa „EQ“, „Dynamics“ oder „Delay“) 
angezeigt. Dabei werden die einzelnen Plug-Ins in 
den Untermenüs für die Kategorien aufgeführt. In 
der unteren Menüebene werden die Plug-Ins nach 
Hersteller (beispielsweise Bomb Factory, Focusrite 
oder TL Labs) geordnet. Dabei werden die 
einzelnen Plug-Ins in den Untermenüs für die 
Hersteller aufgeführt.

Sprachoptionen (nur Windows)

Sie benötigen Administratorrechte für die 
Eigenschaften der Pro Tools-Anwendung, 
um diese Optionen ändern zu können.

Sprache. – Sie können die Sprache, die Sie in 
der Pro Tools-Anwendung verwenden möchten, 
unabhängig von der verwendeten Sprachversion 
von Windows festlegen.

Default Automatic Naming to English. – mit 
dieser Option werden Session-Elemente in einer 
Session automatisch in englischer Sprache 
benannt, selbst wenn die Pro Tools-Anwendung 
auf eine andere Sprache eingestellt wurde.

Auto-Switch Input Language

Wenn die Auto-Switch Input Language-Option 
aktiviert ist, wechselt die Eingabesprache bei der 
Eingabe von Text automatisch von Englisch zur 
Eingabesprache des jeweiligen Betriebssystems. 
Für die Verwendung von Tastaturbefehlen in 
Pro Tools wird die Sprache automatisch wieder 
auf Englisch zurückgestellt. Wenn die Option 
deaktiviert ist, wird bei der Eingabe von Text 
unabhängig von der Eingabesprache des 
jeweiligen Betriebssystems Englisch verwendet.
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Warnmeldungen und 
Dialogfelder-Abschnitt
Reset „Don't Show This Again“ Settings. – wenn 
Sie durch Auswählen der Don't Show This Again-
Einstellung in einem Dialogfeld in Pro Tools 
Änderungen vorgenommen haben, können Sie auf 
die Reset-Schaltfläche klicken, um wieder zu den 
Standardeinstellungen zurückzukehren.

Show Quick Start Dialog When Pro Tools Starts. 
– ist diese Option aktiviert, zeigt Pro Tools 
das Session Quick Start-Dialogfeld beim 
Programmstart an. Deaktivieren Sie diese Option, 
wenn das Pro Tools Quick Start-Dialogfeld beim 
Start nicht angezeigt werden soll.

Color Coding-Abschnitt
Always Display Marker Colors. – mit dieser 
Einstellung können Sie Markerfarben in der 
Markers-Leiste anzeigen, unabhängig davon, 
welche Einstellungen Sie für Default Clip Color 
Coding wählen. 

MIDI Note Color Shows Velocity. – ist diese 
Option aktiviert, werden MIDI-Noten (in der 
MIDI-Noten-Darstellung) im Edit- und MIDI 
Editor-Fenster in unterschiedlichen 
Schattierungen der zugewiesenen Spurfarbe 
angezeigt. Noten mit hohen Velocity-Werten 
sind dunkler und Noten mit niedrigeren Velocity-
Werten sind heller.

Default Track Color Coding Options

Mit diesen Optionen legen Sie die standardmäßige 
Farbkennzeichnung für Spuren im Edit- und im 
Mix-Fenster fest. Die Optionen sind:

None. – deaktiviert die Farbzuweisung für Spuren.

Tracks and MIDI Channels. – weist die Spurfarbe 
im Mix- oder Edit-Fenster je nach Voice- und 
MIDI-Kanal-Zuweisung zu.

Tracks and MIDI Devices. – weist die Spurfarbe 
im Mix- oder Edit-Fenster je nach Voice- und 
MIDI-Gerät-Zuweisung zu.

Groups. – weist die Spurfarbe je nach Gruppen-ID 
zu. Wenn Gruppen mithilfe des Suspend Groups-
Befehls ausgesetzt werden, werden die Farbleisten 
der Spuren nicht angezeigt.

Track Type. – weist die Spurfarbe je nach Spurart 
(Audio, Auxiliary-Eingang, Master-Fader, VCA-
Master, MIDI, Instrument oder Video) zu.

Default Clip Color Coding Options

Mit diesen Optionen legen Sie die standardmäßige 
Farbkennzeichnung für Spuren, Marker-
Positionen und Clips in der Playlist der Spuren 
sowie der Clipliste fest. Die Optionen sind:

None. – deaktiviert die Farbzuweisung für Clips. 
Clips werden in schwarzer Wellenform oder als 
schwarze MIDI-Noten auf hellgrauen 
Hintergrund dargestellt.

Tracks and MIDI Channels. – weist die Clip-Farbe 
im Edit-Fenster je nach Voice- oder MIDI-Kanal-
Zuweisung zu.

Tracks and MIDI Devices. – weist die Clip-Farbe 
im Edit-Fenster je nach Voice- oder MIDI-Gerät-
Zuweisung zu.

Groups. – weist die Clip-Farbe je nach Gruppen-
ID der entsprechenden Spur zu. Wenn Gruppen 
mithilfe des Suspend Groups-Befehls ausgesetzt 
sind, werden in allen Clips schwarze 
Wellenformen oder schwarze MIDI-Noten auf 
hellgrauen Hintergrund dargestellt.

Track Color. – weist die Clip-Farbe je nach der 
Farbe der entsprechenden Spur zu.

Marker Locations. – weist jedem Marker-Bereich 
in der Markers-Leiste, einschließlich des Bereichs 
vor dem ersten Marker, eine eindeutige Farbe zu.

Clip List Color. – weist die Clip-Farbe entsprechend 
der jeweiligen Farbe des Clips in der Clipliste zu.
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Operation Preferences

Transport-Abschnitt
Timeline Insertion/Play Start Marker Follows 
Playback. – bei aktivierter Option werden sowohl 
Timeline Insertion-Marker als auch Play Start-
Marker an die Position auf der Timeline 
verschoben, an der die Wiedergabe gestoppt wird. 
Ist die Option deaktiviert, folgen der Timeline 
Insertion- und der Play Start-Marker nicht der 
Wiedergabe, sondern kehren an die Position 
zurück, an der die Wiedergabe gestartet wurde.

Edit Insertion Follows Scrub/Shuttle. – wenn 
diese Option aktiviert ist, erscheint der Edit-Cursor 
automatisch an der Stelle, an der das Scrubbing 
beendet wird.

Audio During Fast Forward/Rewind. – ist diese 
Option aktiviert, sind die Audiosignale während 
des schnellen Rück- und Vorlaufs hörbar.

Latch Forward/Rewind. – bei Aktivierung dieser 
Option arbeiten Vor- und Rücklauf im Latch-
Modus, bis Sie im Transport-Fenster „Stop“, 
„Play“, „Return To Zero“ oder „Go To End“ 
wählen. Bei Deaktivierung arbeiten Vor- und 
Rücklauf nur, solange die Maustaste nach dem 
Klicken auf eine der Schaltflächen im Transport-
Fenster gedrückt gehalten wird (oder solange der 
entsprechende Schalter auf einer Bedienoberfläche 
gehalten wird).

Play Start Marker Follows Timeline Selection. – 
ist diese Option aktiviert, wird der 
Wiedergabestart-Marker am Startpunkt der 
Timeline-Selektion ausgerichtet, wenn Sie die 
Timeline-Selektion verschieben, eine neue 
Timeline-Selektion vornehmen oder den 
Startpunkt der Timeline-Selektion anpassen. 
Bei deaktivierter Option werden Wiedergabestart-
Marker und Timeline-Selektion nicht 
gleichzeitig verschoben.

Reserve Voices for Preview in Context (nur HDX 
und HD Native). – wenn diese Option aktiviert ist, 
reserviert Pro Tools eine angemessene Anzahl von 
Voices für das Abhören im Kontext (Abhören von 
Audiodateien in Workspace-Browsern während 
der Session-Wiedergabe). Die Anzahl der 
verfügbaren Voices ist beschränkt durch die 
Kanalanzahl der auf der Output-Registerkarte des 
I/O Setup-Dialogfeld ausgewählten Abhörpfade. 
Wenn beispielsweise die Anzahl der Wiedergabe-
Voices in der Playback Engine auf 48 gestellt 
ist und im I/O Setup-Dialogfeld ein Stereo-
Abhörpfad ausgewählt ist, stehen nur 46 Voices 
für Spuren zur Verfügung. Wenn Sie einen 5.1-
Abhörpfad nutzen, stehen nur 42 Voices zur 
Verfügung. Wenn diese Option deaktiviert ist, 
können Sie das Abhören im Kontext nicht starten, 
wenn nicht genug Voices zur Verfügung stehen.

Drücken Sie Windows + N (Windows) bzw. 
Ctrl + N (Mac), um zwischen Aktivierung 
und Deaktivierung der Timeline 
Insertion/Play Start Marker Follows 
Playback-Option zu wechseln.
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Custom Shuttle Lock Speed. – mit dieser Option 
legen Sie die höchste Vorlaufgeschwindigkeit 
(Taste 9) für die Shuttle Lock-Modi (Classic oder 
Transport) fest. Dieser Wert kann zwischen 50 und 
800 % liegen. 

Custom FF/REW Speed. – legt die 
Geschwindigkeit für den schnellen Vor- und 
Rücklauf im Vergleich zur normalen 
Wiedergabegeschwindigkeit fest. Dieser Wert 
kann zwischen 100 und 3.200 % liegen. 

Back/Forward Amount (nur Pro Tools HD). – legt 
die Standardlänge für Back, Back and Play, 
Forward und Forward and Play fest. Die Zeitbasis 
der Back/Forward Amount-Einstellungen folgt 
standardmäßig der Haupt-Zeitskala. Alternativ 
dazu können Sie die Follow Main Time Scale-
Option deaktivieren und ein anderes Zeitbasis-
Format selektieren: „Bars|Beats“, „Min:Sec“, 
„Time Code“, „Feet+Frames“ oder „Samples“.

Ziffernblock-Modus

Der Ziffernblockmodus legt die Funktionsweise des 
Ziffernblocks fest. Sie können den Ziffernblock 
immer benutzen, um Werte in den Edit Event-
Bereich, in die Edit-Selektions-Anzeigen, den 
Haupt- und Nebenzähler und die Transport-Felder 
einzugeben bzw. darin auszuwählen.

Classic. – dieser Shuttle Lock-Modus simuliert 
die Funktionsweise von Pro Tools in den 
Vorversionen von 5.0. Wenn der Ziffernblock-
Modus auf Classic gesetzt ist, können Sie bis zu 
zwei Audiospuren im Shuttle Lock-Modus 
wiedergeben. Halten Sie die Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) gedrückt und 
drücken Sie dann für die verschiedenen 
Wiedergabegeschwindigkeiten eine der Tasten 
0–9. Drücken Sie Plus (+) oder Minus (–), um die 

Richtung umzukehren. Rufen Sie die Memory 
Locations auf, indem Sie die Nummer der 
entsprechenden Memory Location gefolgt von 
einem Punkt (.) eingeben. 

Transport. – mit diesem Shuttle Lock-Modus 
können Sie eine Reihe von Aufnahme- und 
Wiedergabefunktionen einstellen und den 
Transport über den Ziffernblock steuern. Wenn der 
Ziffernblock-Modus auf Transport gesetzt ist, 
können Sie bis zu zwei Audiospuren im Shuttle 
Lock-Modus wiedergeben. Halten Sie die 
Windows-Taste (Windows) bzw. Ctrl-Taste (Mac) 
gedrückt und drücken Sie dann für die 
verschiedenen Wiedergabegeschwindigkeiten eine 
der Tasten 0–9. Drücken Sie Plus (+) oder Minus 
(–), um die Richtung umzukehren. Rufen Sie 
Memory Locations auf, indem Sie einen Punkt (.), 
dann die Nummer der entsprechenden Memory 
Location und anschließend wieder einen 
Punkt (.) eingeben. 

Shuttle (nur Pro Tools HD). – diese Option dient 
zum Auswählen eines Shuttling-Typs, der sich 
vom Shuttle Lock-Modus unterscheidet. Ist der 
Ziffernblock-Modus auf Shuttle gesetzt, können 
Sie die Wiedergabe durch Drücken und Halten der 
entsprechenden Tasten des Ziffernblocks starten. 
Sobald Sie die Tasten loslassen, wird die 
Wiedergabe angehalten. Sowohl bei der Vorwärts- 
als auch bei der Rückwärtswiedergabe stehen 
verschiedene Geschwindigkeiten zur Verfügung. 
Sie können auch die einzelnen Memory Locations 
aufrufen, indem Sie einen Punkt (.), dann die 
Nummer der entsprechenden Memory Location 
und anschließend wieder einen Punkt (.) eingeben.

Weitere Informationen finden Sie unter 
„Custom Shuttle Lock Speed“ auf Seite 571.

Informationen zum Einstellen der höchsten 
Shuttle Lock-Vorwärtsgeschwindigkeit 
finden Sie unter „Custom Shuttle Lock 
Speed“ auf Seite 571.
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Use Separate Play and Stop Keys 

Ist diese Option aktiviert, können Sie die 
Wiedergabe mit der Eingabetaste starten und mit 
der Taste 0 auf dem Ziffernblock anhalten. Dies 
ist für das schnelle Starten und Anhalten der 
Wiedergabe beim Abhören von Loop-Übergängen 
hilfreich. Die Use Separate Play and Stop Keys-
Option ist nur im Ziffernblock-Modus 
„Transport“ verfügbar.

Auto Backup-Abschnitt
Enable Session File Auto Backup. – wenn diese 
Option aktiviert ist, erstellt Pro Tools während 
der Arbeit automatisch Backup-Kopien Ihrer 
Pro Tools-Session-Datei. Diese Sicherungskopien 
werden im Session File Backups-Ordner innerhalb 
des Session-Ordners gespeichert. 

Keep. – bestimmt die Gesamtzahl der aufeinander 
folgenden Backups, die aufbewahrt werden.

Backup Every. – legt fest, wie häufig die Session 
gespeichert wird.

User Library-Abschnitt

Root:

Klicken Sie auf die Change-Schaltfläche, um 
das Root-Verzeichnis für alle Benutzerdateien, 
einschließlich Dokumentation, Grooves, I/O-
Einstellungen, Plug-In-Maps, Plug-In-Einstellungen, 
Session-Vorlagen und Videotestmuster festzulegen.

Video-Abschnitt

Enable GPU

Die Pro Tools-Videoverarbeitung läuft über die GPU 
(Grafikprozessor), um Prozessor-Ressourcen für 
Pro Tools-Audio und -MIDI zu schaffen. Wenn Sie 
eine langsamere GPU verwenden und dadurch eine 
mangelhafte Videowiedergabe erhalten, können Sie 
diese Option deaktivieren und die Videoverarbeitung 
über den Prozessor laufen lassen.

Prevent Tearing

Wenn aktiviert, puffert Pro Tools Video, damit bei 
horizontaler Bewegung keine Artefakte erscheinen, 
wenn die Videosynchronisation nicht der 
Aktualisierungsrate des Bildschirms entspricht. 
Diese Option ist nicht verfügbar, wenn die Enable 

GPU-Option deaktiviert ist.

Enable Hardware During Scrub

Wenn die Option Enable Hardware During Scrub 
aktiviert ist, können Sie per Hardware (z. B. Avid 
Mojo DX oder Nitris DX-Video-Peripheriegeräte) 
beim Scrubben eine Videovorschau anzeigen. 
Bei deaktivierter Option können Sie beim 
Scrubben nur im Videofenster von Pro Tools die 
Video-vorschau anzeigen. Wenn beim Monitoring 
von Video unter Verwendung von Videohardware 
beim Scrubben Leistungsprobleme auftreten, 
sollten Sie diese Option deaktivieren.

Play Start Latency

Wenn Sie auf einem langsameren Computer 
arbeiten, sollten Sie die Play Start Latency-
Einstellung auf einen höheren Wert setzen. 
Der Wert kann 1-Shortest bis 5-Longest betragen.

Bei aktivierter Option wird die Verwendung 
der Eingabetaste zum Hinzufügen von 
Memory Location-Markern außer Kraft 
gesetzt. Drücken Sie stattdessen die Punkt-
Taste (.) und danach die Eingabetaste auf 
dem Ziffernblock, um einen Memory 
Location-Marker hinzuzufügen.
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Record-Abschnitt
Latch Record Enable Buttons. – wenn diese 
Option aktiviert ist, können mehrere Audiospuren 
für die Aufnahme scharfgeschaltet werden. Ist sie 
deaktiviert, ist das Scharfschalten mehrerer Spuren 
nicht möglich. Die Scharfschaltung aller anderen 
Audiospuren wird zurückgesetzt, sobald eine neue 
Audiospur scharfgeschaltet wird.

Automatisierung im Record-Modus. – ist diese 
Option aktiviert, kann Automation sowohl 
während der Aufnahme als auch während der 
Wiedergabe geschrieben werden. Ist diese Option 
deaktiviert, kann Automation nur während der 
Wiedergabe geschrieben werden.

Hinweis: Ist die Option Enable Automation in 

Record ausgewählt, wird die Option Link Record 

and Play Faders automatisch deaktiviert und steht 
nicht zur Verfügung.

Link Record and Play Faders. – wenn diese 
Option aktiviert ist, speichert Pro Tools bei einer 
Scharfschaltung keine separaten Fader-Pegel, 
sodass Sie während der Aufnahme und 
Wiedergabe denselben Abhörpegel für Spuren 
beibehalten können. 

Audio Track RecordLock (nur Pro Tools HD). – 
mit dieser Option können Pro Tools-Spuren so 
konfiguriert werden, dass sie entweder einen 
Digital Dubber simulieren oder das Verhalten für 
den Spuraufnahmestatus aus früheren Versionen 
beibehalten. 

• Ist diese Option aktiviert, bleiben 
scharfgeschaltete Audiospuren scharfgeschaltet, 
wenn die Wiedergabe bzw. Aufnahme 
angehalten wird. 

• Ist sie deaktiviert, wird die Scharfschaltung von 
Audiospuren aufgehoben, wenn Pro Tools 
angehalten wird. Dadurch wird vermieden, dass 
Spuren von einem Durchgang zum nächsten 
scharfgeschaltet bleiben (Simulation des 
Spuraufnahmeverhaltens eines Digital Dubber). 

Transport RecordLock (nur Pro Tools HD). – mit 
dieser Option kann die Transport Record-Funktion 
(die Record-Schaltfläche im Transport-Abschnitt) 
so konfiguriert werden, dass entweder ein Digital 
Dubber simuliert oder das frühere Verhalten des 
Hauptaufnahmeschalters (Record) beibehalten wird. 

• Wenn die RecordLock-Funktion aktiviert ist, 
bleibt die Record-Schaltfläche im Transport-
Abschnitt bei Anhalten der Wiedergabe oder 
Aufnahme scharfgeschaltet. Damit wird die 
erneute Scharfschaltung des Transports 
zwischen den Takes überflüssig. Ein solches 
Verhalten simuliert das eines Digital Dubbers. 

• Ist diese Funktion deaktiviert, wird die Record-
Schaltfläche im Transport-Abschnitt deaktiviert, 
sobald Pro Tools manuell angehalten wird oder 
aufgrund eines Timecode-Verlusts anhält. Dies 
entspricht dem Standard-Aufnahmeverhalten 
von Pro Tools. 

Die Transport RecordLock-Option wird 
automatisch deaktiviert und abgeblendet, wenn der 
Destructive-Aufnahmemodus aktiviert ist.

Disable “Input” When Disarming Track 
(In “Stop”) (nur Pro Tools HD). – für eine höhere 
Flexibilität kann die TrackInput-Abhörfunktion 
vom Anwender so angepasst werden, dass sie 
entweder unabhängig vom Aufnahmestatus der 
Spur ausgewählt bleibt oder nach einem 
Aufnahmedurchgang automatisch auf den 
Abhörmodus „Auto Input“ umgeschaltet wird. 
Damit können Sie das Abhören für einen typischen 
Dubbing-Arbeitsablauf (bei dem Sie die Spuren 
gegebenenfalls so lange im Input Only-Modus 
belassen möchten, bis sie eigens in den Auto Input-
Modus umgeschaltet werden) oder einen typischen 
Arbeitsablauf bei der Musikaufnahme (bei dem 
das Belassen einer Spur im Input Only-Modus 
zu versehentlichem Doppelabhören führen kann) 
optimieren.
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• Wenn diese Option aktiviert ist, bewirkt das 
Aufheben der Scharfschaltung einer Audiospur 
(beliebiger Modus), dass unabhängig vom 
allgemeinen Monitor-Modus auch der Input 
Only-Modus aufgehoben wird und das 
Abhören der Spur ausschließlich von der 
Festplatte erfolgt. 

• Ist diese Option deaktiviert, verbleiben die 
Audiospuren im Input Only-Abhörmodus, 
bis sie eigens in den Auto Input-Abhörmodus 
umgeschaltet werden. 

Mute Record-Armed Tracks While Stopped 
(nur Pro Tools HD). – diese Einstellung bestimmt 
den Abhörstatus scharfgeschalteter Spuren. 

• Wenn diese Option aktiviert ist, schaltet 
Pro Tools alle scharfgeschalteten Spuren 
stumm, wenn der Transport angehalten wird. 
Input-Signale können mithilfe der TrackInput 
Monitor-Schaltfläche auch in angehaltenem 
Zustand abgehört werden.

• Ist diese Option deaktiviert, schaltet Pro Tools 
Audio-Input auf scharfgeschalteten Spuren 
nicht stumm, wenn der Transport 
angehalten wird.

PEC/Direct Style Input Monitoring (nur 
Pro Tools HD). – diese Option ändert die Art, 
wie der TrackInput-Abhörmodus auf dem 
Bildschirm (und unterstützten Bedienoberflächen) 
für die Emulierung der Anzeigeoptionen „PEC“ 
(Wiedergabe) und „Direct“ (Eingang/Bus) auf 
einigen Großkonsolen angezeigt wird. 

• Ist diese Option deaktiviert, wird auf der 
TrackInput-Schaltfläche der Buchstabe „I.“ 
angezeigt. Die Schaltfläche bleibt im Auto 
Input-Modus grau und leuchtet im Input Only-
Modus grün auf.

• Ist die Option aktiviert, bleibt die TrackInput-
Schaltfläche im Input Only-Modus („Direct“) 
grau und ist mit dem Buchstaben „D“ 
gekennzeichnet. Im Auto Input-Modus („PEC“ 
oder Wiedergabe“) leuchtet sie hingegen grün 
auf und zeigt den Buchstaben „P“ an.

Automatically Create New Playlists When Loop 
Recording. – ist diese Option aktiviert, werden mit 
Loop Record erstellte, alternative Takes in neue 
Playlists in die Spur kopiert. Dies ist besonders 
nützlich zur Vorbereitung zusammengesetzter 
Spuren (Compositing) in der Playlists-Darstellung, 
nachdem mehrere alternative Takes mit Loop 
Record erstellt wurden.

Online-Optionen

Record Online at Timecode (or ADAT) Lock. – 
wenn diese Option aktiviert ist, startet die Online-
Aufnahme, sobald ein gültiger Timecode anliegt 
und Pro Tools sich darauf eingelockt hat.

Record Online at Insertion/Selection. – ist diese 
Option aktiviert, beginnt die Online-Aufnahme an 
der Position des Edit-Cursors. Die Aufnahme wird 
so lange fortgesetzt, bis Pro Tools keinen Timecode 
mehr empfängt. Wenn Sie eine Selektion 
vorgenommen haben, nimmt Pro Tools nur für die 
Länge dieses Abschnitts auf. 

DestructivePunch File Length (nur Pro Tools HD)

– mit dieser Voreinstellung wird die Dauer 
konsolidierter Audiodateien bei der Vorbereitung 
von Spuren für den DestructivePunch-Modus 
festgelegt. Der Standardwert für diese Einstellung 
liegt bei 25 Minuten. 
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Misc(Miscellaneous)-Abschnitt
Clip Auto Fade In/Out Length (nur Pro Tools HD). 
– über diese Option stellen Sie eine Standardlänge für 
Fade-Ins und Fade-Outs ein, die automatisch auf 
Clip-Anfang und -Ende angewendet wird. Wenn Sie 
automatische Fade-Ins/-Outs verwenden, ersparen 
Sie sich die Mühe, für das Editing die entsprechenden 
Zero-Crossings (Nulllinienschnittpunkte) zu suchen 
oder zahlreiche Fade-Ins/-Outs nur zu dem Zweck zu 
erstellen, unerwünschte Tick- oder Knackgeräusche 
bei der Wiedergabe zu eliminieren. Automatische 
Fade-Ins/-Outs werden nicht auf die Festplatte 
geschrieben. Im Auto Clip Fade In/Out Length-
Feld können Sie einen Wert zwischen 0 und 10 ms 
wählen. Der Wert Null bedeutet, dass keine 
automatischen Fade-Ins/-Outs erstellt werden. 
Der jeweils gewählte Wert wird zusammen mit 
der Session gespeichert und automatisch auf alle 
frei stehenden Clip-Grenzen angewendet, 
bis Sie ihn ändern.

Calibration Reference Level (nur Pro Tools|HDX 
and Pro Tools|HD Native-Systeme). – über dieses 
Feld legen Sie einen Standardreferenzpegel in dB 
für die Kalibrierung für den Calibration-Modus 
von Pro Tools fest. Wenn Ihr Audio-Interface über 
Trim-Regler verfügt (wie etwa HD I/O), lesen Sie 
die Anweisungen zur Kalibrierung im 
Benutzerhandbuch zum Interface.

Delay Compensation Time Mode. – wenn Delay 
Compensation aktiviert ist (Options > Delay 

Compensation), können Sie bestimmen, ob die 
Informationen im Delay Manager in Millisekunden 
oder Samples angezeigt werden sollen.

Compensate Side Chains (nur Pro Tools|HDX 
Systems). – wenn Delay Compensation aktiviert 
ist (Options > Delay Compensation), wird mittels 
dieser Option Delay Compensation auf die Plug-
In-Sidechain-Signale angewendet. 

Wenn Ihr System einen oder mehrere EUCON-
Controller enthält, sollte „Auto-bank to 
selected track“ in der EuControl-Software 
deaktiviert werden, bevor der Pro Tools-
Kalibrierungsmodus zur Stummschaltung der 
Fader aktiviert wird. Um sicherzugehen, dass 
„Auto-bank to select track“ nicht aktiviert ist, 
öffnen Sie das Fenster „EuControl Settings“, 
klicken Sie auf die General-Registerkarte und 
vergewissern Sie sich, dass die Einstellung 
nicht aktiviert ist. Wenn notwendig, 
deaktivieren Sie „Auto-bank to selected 
track“. Nachdem Sie den Kalibrierungsmodus 
verlassen haben, aktivieren Sie die Einstellung 
„Auto-bank to selected track“ wieder 
(wenn notwendig).
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Editing-Voreinstellungen

Clips-Abschnitt
Clip List Selection Follows Edit Selection. – ist 
diese Option aktiviert und Sie wählen auf einer 
Spur einen Clip aus, so wird diese auch in der 
Clipliste ausgewählt. 

Edit Selection Follows Clip List Selection. – ist 
diese Option aktiviert und Sie wählen einen Clip in 
der Clipliste aus, markiert Pro Tools die Stelle auf 
der Spur, an der sich dieser Clip befindet.

Auto-Name Separated Clips. – ist diese Option 
aktiviert, benennt Pro Tools automatisch alle neu 
separierten Clips, indem es an den jeweiligen 
Namen des Clips eine Zahl anhängt.

“Separate Clip” Operates On All Related Takes. 
– ist diese Option aktiviert, wirkt sich das Editieren 
eines Clips mit dem Separate Clip-Befehl auch auf 
alle anderen Takes (Aufnahmedurchgänge) mit dem 
gleichen Benutzerzeitstempel aus. Diese Option 
ermöglicht es, analoge Abschnitte einer Gruppe 
verwandter Takes miteinander zu vergleichen.

Clip Gain Nudge Value. – diese Einstellung gibt 
den Wert an (von 0,1 dB bis 6,0 dB), um den Clip-
Gain-Einstellungen durch die Nudge-Funktion 
angepasst werden.

Tracks-Abschnitt
New Tracks Default To Tick Timebase. – wenn 
diese Option aktiviert ist, basieren alle neuen 
Spuren standardmäßig immer auf Ticks. Wenn die 
Option deaktiviert ist, basieren Audio-, Auxiliary-
Eingangs-, Master-Fader- und VCA-Spuren (nur 
Pro Tools HD) auf Samples.

Memory Locations-Abschnitt
Auto-Name Memory Locations When Playing. – 
ist diese Option aktiviert, benennt Pro Tools die 
Memory Locations auf der Grundlage ihrer 
zeitlichen Position in der Session um. Die aktuell 
im View-Menü ausgewählten Zeiteinheiten 
bestimmen die Einheiten für die Namen. 

Recall Memory Location at Original Track. – ist 
diese Option aktiviert, rufen die Memory Locations, 
die eine Selektion aufrufen, auch die Spur auf, in der 
die Selektion vorgenommen wurde.

Fades-Abschnitt
Crossfade Preview Pre-Roll. – über diese 
Einstellung legen Sie den Pre-Roll-Wert fest, 
der beim Abhören von Crossfades im Fades-
Dialogfeld hinzugefügt werden soll.

Crossfade Preview Post-Roll. – über diese 
Einstellung legen Sie den Post-Roll-Wert fest, 
der beim Abhören von Crossfades im Fades-
Dialogfeld hinzugefügt werden soll.
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QuickPunch/TrackPunch Crossfade Length. 
– legt eine Standardlänge für Crossfades fest, 
die durch eine QuickPunch- oder TrackPunch-
Aufnahme (nur Pro Tools HD) erstellt wurden. 
Crossfades treten vor dem Punch-In und nach 
dem Punch-Out auf. 

Preserve Fades when Editing. – mit dieser Option 
werden Fade-Ins und Fade-Outs beibehalten und 
separate Crossfades in entsprechende Fade-Ins und 
Fade-Outs konvertiert.

Fade-Standardeinstellungen

Fade In. – mit dieser Option wählen Sie bei 
der Verwendung des Smart-Tools die Standard-
Hüllkurvenform für Fade-Ins aus.

Fade Out. – mit dieser Option wählen Sie bei 
der Verwendung des Smart-Tools die Standard-
Hüllkurvenform für Fade-Outs aus.

Crossfade. – mit dieser Option wählen Sie bei 
der Verwendung des Smart-Tools die Standard-
Hüllkurvenform für Crossfades aus.

REX. – hiermit wählen Sie die Standard-
Hüllkurvenform für Fades und Crossfades zwischen 
Clips („Slices“) in importierten REX-Dateien.

Zoom Toggle-Abschnitt
Vertical Zoom. – hiermit wird für die Zoom Toggle 

Vertical Zoom-Einstellung entweder Selection 
oder Last Used ausgewählt.

Horizontal Zoom. – hiermit wird für die Zoom 

Toggle Horizontal Zoom-Einstellung entweder 
Selection oder Last Used ausgewählt.

Remove Range Selection After Zooming In. 
– wenn diese Option aktiviert ist, wird der aktuelle 
Bearbeitungsbereich nach dem Einzoomen zu 
einem Einfügepunkt verkleinert. Wenn wieder 
ausgezoomt wird, wird die vorherige Auswahl 
erneut eingeblendet.

Track Height. – hiermit wird für die Zoom Toggle 

Track Height-Einstellung die Option Last Used, 
Medium, Large, Extreme oder Fit To 

Window ausgewählt.

Track View. – hiermit wird für die Zoom 

Toggle Track View-Einstellung die Option 
Waveform/Notes, Warp/Notes, Last Used oder 
No Change ausgewählt.

Separate Grid Settings When Zoomed In. – ist 
diese Option aktiviert, werden die mit dem 
Zoomwechsel gespeicherten Rastereinstellungen 
beim Zoomwechsel erneut aufgerufen. Wenn diese 
Option nicht ausgewählt ist, bleiben bei 
Zoomwechseln die (aktuellen) 
Rastereinstellungen unverändert.

Zoom Toggle Follows Edit Selection. – wenn 
diese Option aktiviert ist, folgt der Zoomwechsel 
automatisch der aktuellen Bearbeitungsauswahl. 
Wenn diese Option deaktiviert ist, hat das Ändern 
der Edit-Selektion keine Auswirkungen auf die 
gerade angezeigte Spur.

Rückgängig-Schritte 
(Levels of Undo)
Hier stellen Sie die maximale Anzahl der 
Vorgänge ein, die mithilfe der entsprechenden 
Funktion wieder rückgängig gemacht werden 
können. Die Wahl eines niedrigeren Werts 
kann die Leistung von langsameren Computern 
beschleunigen. Pro Tools unterstützt bis zu 
64 Rückgängig-Vorgänge.

Um einen Fade-In, Fade-Out oder Crossfade 
mit den Standardeinstellungen für Fades auf 
eine Bearbeitungsauswahl anzuwenden, 
ohne dafür das Fades-Dialogfeld zu öffnen, 
drücken Sie Strg + Windows + F (Windows) 
bzw. Befehl + Ctrl + F (Mac).
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Mixing-Voreinstellungen

Setup-Abschnitt
Sends Default to –INF. – wenn diese Option 
aktiviert ist, setzen Sie den Ausgangspegel des 
Faders für neu erstellte Sends auf –∞ (nicht 
hörbarer Signalpegel). Andernfalls wird der 
Ausgangspegel des Faders für neu erstellte Sends 
auf 0 dB gesetzt.

Send Pans Default to Follow Main Pan. – ist diese 
Option aktiviert, ist bei neu erstellten Sends die 
Follow Main Pan-Option aktiviert, sodass die Send 
Pan-Einstellungen den Pan-Einstellungen auf 
der Spur folgen. Ist die Option nicht aktiviert, 
ist die Follow Main Pan-Option bei neuen 
Sends deaktiviert.

Link Mix and Edit Group Enables. – ist diese 
Option aktiviert, werden Aktivierung und 
Deaktivierung der Mix- und Edit-Gruppen 
gekoppelt. Wenn Sie beispielsweise im Mix-
Fenster „Group A“ aktivieren, wird automatisch 
auch im Edit-Fenster „Group A“ aktiviert.

Use Absolute Pan Linking (nur Pro Tools HD). 
– diese Option beeinflusst das Verhalten 
gruppierter Pan-Einstellungen.

• Wenn sie ausgewählt ist, verlieren gruppierte Pan-
Steuerungen ihre relativen Offsets, wenn eine 
beliebige der gruppierten Pan-Einstellungen 
angepasst wird. Alle gruppierten Pan-Steuerungen 
werden am absoluten Wert der angepassten 
Steuerung ausgerichtet. 

• Wenn die Option nicht ausgewählt ist, behalten 
gruppierte Pan-Steuerungen ihre relativen 
Offsets bei, wenn ein beliebiges der gekoppelten 
Steuerungen angepasst wird.

Default EQ

Bei dieser Voreinstellung können Sie jedes 
installierte EQ-Plug-In als Standard auswählen, 
das daraufhin für eine schnelle Zuweisung sowohl 
auf dem Bildschirm als auch auf ICON-Controller 
(nur Pro Tools HD) zur Verfügung steht. Auf dem 
Bildschirm wird das Plug-In oberhalb des Insert-
Selektors angezeigt. Auf ICON-Controllern 
erscheint das Plug-In an erster Stelle in der 
Menüauswahl der Drehgeber.

Default Dynamics

Bei dieser Voreinstellung können Sie jedes 
installierte Dynamics-Plug-In als Standard 
auswählen, das daraufhin für eine schnelle 
Zuweisung sowohl auf dem Bildschirm als auch 
auf ICON-Controller (nur Pro Tools HD) zur 
Verfügung steht. Auf dem Bildschirm wird das 
Plug-In oberhalb des Insert-Selektors angezeigt. 
Auf ICON-Controllern erscheint das Plug-In an 
erster Stelle in der Menüauswahl der Drehgeber.
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Controllers-Abschnitt
Edit Window Follows Bank Selection. – bei 
Verwendung eines unterstützten externen Controllers 
zeigt diese Option, wenn Sie über Ihren Controller 
eine neue Spuren-Bank auswählen, den Bereich des 
Edit-Fensters mit der ausgewählten Bank an. 
Dadurch wird gewährleistet, dass immer die aktuelle 
Bank auf dem Bildschirm angezeigt wird.

Mix Window Follows Bank Selection. – bei 
Verwendung eines unterstützten externen Controllers 
zeigt diese Option, wenn Sie über Ihren Controller 
eine neue Spuren-Bank auswählen, den Bereich des 
Mix-Fensters mit der ausgewählten Bank an. 
Dadurch wird gewährleistet, dass immer die aktuelle 
Bank auf dem Bildschirm angezeigt wird.

“Scroll to Track” Banks Controllers. – wenn Sie 
eine Bedienoberfläche wie D-Control verwenden, 
können Sie diese Option aktivieren, um die Fader 
der Bedienoberfläche beim Aufrufen des Scroll 
to Track-Befehls auf einer nummerierten 
Spur zusammenzufassen.

Always Fill Channel Strips When Banking. 
– wenn Sie einen ICON-Controller 
(nur Pro Tools HD) oder eine andere unterstützte 
Bedienoberfläche verwenden, können Sie diese 
Option auswählen, um die Anzahl der angezeigten 
Kanäle beim Banking zu maximieren. Mit dieser 
Einstellung werden die Bank-Befehle so optimiert, 
dass die Anzeige einer kleinen Anzahl von 
Kanälen an den äußeren Rändern der Oberfläche 
verhindert wird.

Touch Timeout. – wenn Sie Automationsdaten 
im Touch-Modus aufzeichnen und aufhören, 
einen nicht berührungsempfindlichen Fader 
oder Drehregler zu bewegen, fährt Pro Tools 
für den Zeitraum des Touch-Timeouts mit der 
Aufzeichnung der Automation fort.

Nach dem Touch-Timeout stoppt die Aufzeichnung 
der Automation und die Automationsdaten 
kehren im in der AutoMatch Time-Einstellung 
festgelegten Zeitraum auf ihren vorherigen 
Automationswert zurück.

Automation-Abschnitt
Smooth and Thin Data After Pass. – wenn Sie 
diese Option aktivieren, entfernt Pro Tools nach 
einem Automationsdurchgang automatisch die 
irrelevanten Automationsdaten entsprechend 
Ihren Vorgaben. 

Degree of Thinning. – diese Option gibt an, wie 
viele Automationsdaten entfernt werden, wenn Sie 
den Thin Automation-Befehl verwenden oder die 
Smooth and Thin Data After Pass-Option 
ausgewählt haben. 

Plug-In Controls Default to Auto-Enabled. 
– wenn diese Option aktiviert ist, werden alle 
relevanten Einstellungen neu hinzugefügter Plug-
Ins für die Automation aktiviert. Ist sie deaktiviert, 
müssen alle relevanten Einstellungen neu 
hinzugefügter Plug-Ins manuell für die 
Automation aktiviert werden. 

Suppress Automation “Write To” Warnings 
(nur Pro Tools HD). – ist diese Option aktiviert, 
unterdrückt Pro Tools die Warnungen, die nach 
dem Aufrufen des Write Automation To Start-, 
Selection-, End- oder Punch-Befehls angezeigt 
werden und dann den Transport anhalten.

Latching Behavior for Switch Controls in 
„Touch“. – mit dieser Option wird das Verhalten 
der Schalter-Einstellungen (etwa Stummschalten 
oder Plug-In-Bypass) beim Schreiben von 
Automationsdaten im Touch-Modus festgelegt.

• Ist die Option aktiviert, werden Einstellungen 
im Touch-Modus in ihrem aktuellen Status 
gekoppelt. Wenn ein bestehender Breakpoint 
gefunden wird, wird das Schreiben von 
Automationsdaten angehalten. Wird der 
Transport während des Schreibvorgangs 
angehalten, wird das Bedienelement sich 
automatisch am zugrunde liegenden Wert 
orientieren (AutoMatch).

• Ist die Option deaktiviert, werden Einstellungen 
im Touch-Modus nicht gekoppelt. 
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Allow Latch Prime in Stop (nur Pro Tools HD). 
– ist diese Option aktiviert und es befinden sich 
Spuren im Latch-Modus, können sämtliche für 
die Automation aktivierte Einstellungen für 
diese Spuren auf neue Werte eingestellt werden, 
während der Transport durch Berühren oder 
Bewegen von Steuerelementen angehalten wird. 
So können Vorbereitungen für den nächsten 
Automationsdurchgang getroffen werden. 

Coalesce when Removing Slaves from VCA 
Group (nur Pro Tools HD). – mit dieser Option 
wird das Verhalten beim Entfernen von Slave-
Spuren aus einer VCA-gesteuerten 
Gruppe festgelegt.

• Ist die Option aktiviert, werden alle auf dem 
VCA-Master vorhandenen Automationsdaten 
beim Entfernen von Spuren aus der Gruppe 
automatisch (ohne Bestätigung) mit den 
entsprechenden Slave-Spuren verbunden.

• Ist die Option deaktiviert, können Sie in einem 
Bestätigungsdialogfeld wählen, ob Sie die 
VCA-Master-Automation mit den Slave-
Spuren verbinden möchten oder nicht.

Standard VCA Logic for Group Attributes (nur 
Pro Tools HD). – diese Option legt fest, welche 
Mix-Gruppenattribute im Group-Dialogfeld 
ausgewählt werden können, wenn die Gruppe 
einem VCA-Master zugewiesen wird. 

• Ist die Option aktiviert, folgen die Main 
Volume-, Mute-, Solo-, Record Enable- und 
Input Monitoring-Einstellungen auf Slave-
Spuren nur dem VCA-Master und können nicht 
unabhängig verknüpft werden. (Hiermit wird 
das Verhalten von VCA-Mastern analoger 
Konsolen emuliert.)

• Ist die Option deaktiviert, folgen die Main 
Volume-, Mute-, Solo-, Record Enable- und 
Input Monitoring-Einstellungen zwar dem 
VCA-Master, können aber weiterhin 
unabhängig mit Gruppen verknüpft werden.

Include Sends in Trim Mode (nur Pro Tools HD). 
– mit dieser Option wird der Trim-Status von 
Send-Fadern festgelegt, wenn eine Spur in den 
Trim-Modus versetzt wird.

• Ist sie aktiviert, werden Send-Fader zusammen 
mit dem Main Volume-Fader in den Trim-
Modus versetzt. 

• Ist sie deaktiviert, wird der Main Volume-Fader 
in den Trim-Modus versetzt, der Send-Fader 
bleibt hingegen im entsprechenden Standard-
Automationsmodus.

Include Control Changes in Undo Queue. – mit 
dieser Option wird festgelegt, ob bestimmte 
Änderungen an Mischpult-Steuerelementen, 
beispielsweise das Verschieben eines Faders 
oder eines Pan-Reglers, in die Undo-Schlange 
aufgenommen werden.

• Ist die Option aktiviert, erscheinen Änderungen 
an Mischpult-Steuerungen in der Undo-
Schlange und werden rückgängig gemacht, 
wenn eine beliebige vorherige Operation 
rückgängig gemacht wird.

• Ist die Option deaktiviert, werden Änderungen 
an Mischpult-Steuerungen nicht in die Undo-
Schlange aufgenommen, sodass Sie andere 
Vorgänge rückgängig machen können und 
gleichzeitig die aktuellen Mischpulteinstellungen 
beibehalten.

Sämtliche Einstellungen für Standardoperationen, 
die die Mischpult-Steuerungen beeinflussen, 
werden in die Undo-Schlange aufgenommen.

AutoMatch Time. – wenn Sie Automation im 
Touch-Modus aufzeichnen und einen Fader 
oder ein Bedienelement loslassen, hält die 
Aufzeichnung der Automation an und die 
Automationsdaten kehren zu ihrem vorherigen 
Wert zurück. Die Geschwindigkeit, mit der zum 
vorherigen Wert zurückgekehrt wird, ist die 
AutoMatch Time. 
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AutoGlide Time (nur Pro Tools HD). – legt fest, 
wie schnell Pro Tools von einem Automationswert 
zu einem anderen übergeht („gleitet“), wenn der 
AutoGlide-Modus verwendet wird.

After Write Pass, Switch To-Optionen

Mit diesen Optionen wird der Automationsmodus 
ausgewählt, in den Pro Tools-Spuren nach einem 
Automationsdurchlauf im Write-Modus (oder 
Write Trim-Modus) automatisch übergehen. 
Wählen Sie eine der folgenden Optionen:

Touch. – nach einem Automationsdurchlauf im 
Write-Modus (oder Write Trim-Modus) wird in 
den Touch-Modus geschaltet.

Latch. – nach einem Automationsdurchlauf im 
Write-Modus (oder Write Trim-Modus) wird in 
den Latch-Modus geschaltet.

No Change. – nach einem Automationsdurchlauf 
im Write-Modus (oder Write Trim-Modus) wird 
der Write-Modus beibehalten. 

Nach einem Automationsdurchlauf im Write 
Trim-Modus wird automatisch die zu der 
angegebenen Einstellung gehörige Trim-Version 
für die Spuren eingestellt.

Coalesce Trim Automation-Optionen

(Nur Pro Tools HD)

Mit diesen Optionen wird festgelegt, wann die 
Trim-Automation für die Haupt-Automations-
Playlist auf einer Spur vorgenommen wird.

After Every Pass. – die Trim-Automation findet 
gemeinsam mit dem Anhalten des Transports am 
Ende jedes Trim-Automationsdurchlaufs statt. 
Es wird keine Composite-Playlist angezeigt.

On Exiting Trim Mode. – die Trim-Automation 
wird mit einer Spur verbunden, wenn die Spur den 
Trim-Modus verlässt. Eine Composite-Playlist 
kann vor dem Durchführen der Trim-Vorgänge 
angezeigt werden.

Manually. – die Trim-Automation kann nur in 
Verbindung mit dem Coalesce Trim 

Automation-Befehl vorgenommen werden. Eine 
Composite-Playlist kann vor dem Durchführen 
der Trim-Vorgänge angezeigt werden.
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Metering-Voreinstellungen

Spur- und Master-Meter-Typen
Im Track Meters-Bereich der Mixing-
Voreinstellungen können der Anzeigetyp 
sowie die Metering-Werte eingestellt werden. 
Außerdem werden hier die Einstellungen für 
Audio-, Auxiliary-Eingangs- und 
Instrumentenspuren angezeigt. Im Master Meters-
Abschnitt konfigurieren Sie diese Einstellungen 
unabhängig für die Master-Fader-Spuren.

Track and Master Meter Types Linked

Aktivieren Sie die Option Track and Master 

Meter Types Linked, um sicherzustellen, dass die 
Spuranzeigen (Audio, Auxiliary-Eingangs- und 
Instrumentenspuren) und Masteranzeigen (Master 
Fader) immer dieselbe Anzeigetypeinstellung 
verwenden. Deaktivieren Sie diese Option, falls 
die Spur- und Masteranzeigen unterschiedliche 
Anzeigetypeneinstellungen verwenden sollen 
(z. B. falls Sie VU für die Spur- und Peak für die 
Masteranzeigen verwenden möchten).

Spur- und Masteranzeigen

Mit Pro Tools können Sie zwischen 
verschiedenen Standard-Anzeigetypen für das 
visuelle Monitoring von Audiopegeln wählen. 
Sie können die Spur- (Audio, Auxiliary-Eingangs- 
und Instrumentenspuren) und die Masteranzeige-
Einstellungen (Master-Fader) verknüpfen oder 
unabhängig voneinander einstellen. Die folgenden 
Meter Type-Optionen stehen zur Verfügung:

Sample Peak. – dies ist die Standardanzeige 
von Pro Tools. Außerdem ist „Sample Peak“ 
der einzige Anzeigetyp, der von der Nicht-HD-
Version von Pro Tools verwendet wird. Der 
Pegel und die Decay-Zeit werden in dB/Sekunde 
berechnet, was im Vergleich zu älteren Versionen 
von Pro Tools (z. B. Pro Tools 10) zu einem 
langsameren Decay führt. Die Option Sample 

Peak ist der einzige Meter Type, dessen Sample-
Integrationszeit 0 beträgt und der demzufolge alle 
dynamischen Aktivitäten des digitalen Signals zu 
jedem Zeitpunkt anzeigt.

Pro Tools Classic. – diese Option bietet ältere 
Pro Tools-Skalen und -Ballistikwerte.

Linear (nur Pro Tools HD). – verwenden Sie 
Linear für Postproduktions- und Mix-Szenarien. 
Bei einer kurzen Decay-Zeit bietet Linear direktes, 
lineares 1:1-Metering für Sample-Spitzen im 
Audiosignal mit einem Anzeigebereich bis auf 
–40 dB. Dies ermöglicht eine höhere 
Anzeigeauflösung nahe 0 dB (besonders nützlich 
für Mix- und Mastering-Anwendungen).

Linear (Extended, nur Pro Tools HD). 
– enthält die gleichen Werte wie „Linear“. 
Die Anzeigeskala reicht allerdings bis –60 dB.

Metering-Voreinstellungen (in Pro Tools HD)
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RMS (nur Pro Tools HD). Bietet 
Ballistikeigenschaften zur Anzeige der 
durchschnittlichen Lautstärke (quadratisches 
Mittel bzw. Effektivwert des Signals) über einen 
bestimmten Zeitraum. Dagegen wird beim Peak-
Metering der Spitzenwert eines Signals zu einem 
beliebigen Zeitpunkt angezeigt.

VU (nur Pro Tools HD). – die für das Mischen von 
Musik und Dialogen häufig verwendete VU-Skala 
von Pro Tools wurde im unteren Bereich von 
–23 auf –40 dB erweitert, um eine ganze Reihe 
von Materialien ohne den Bedarf einer Bühnen-
Rekalibrierung abzudecken.

Digital VU (nur Pro Tools HD). – bietet die 
Ballistikeigenschaften von VU auf einer modernen 
digitalen Skala.

PPM Digital (nur Pro Tools HD). – die Option 
PPM Digital wird häufig von Sendern in Europa 
und Asien sowie für US-Filmkonsolen 
(z. B. die Avid System5-Konsolen) verwendet. 
Sie bietet eine ähnliche Integrationszeit wie 
Sample Peak aber unterschiedliche Skalen und 
Decay-Zeiten.

PPM Digital meldet genau wie alle anderen Meter 

Type-Optionen, mit Ausnahme von Sample Peak, 
nicht jede Signalspitze (z. B. eine Folge sehr 
schneller Signalspitzen). Obwohl nicht sämtliche 
Daten zum tatsächlichen digitalen Dynamikbereich 
ausgegeben werden, widerspiegelt dieses Verfahren 
eher das menschliche Lautstärkeempfinden über 
einen bestimmten Zeitraum wieder.

PPM BBC (nur Pro Tools HD). – die von 
kommerziellen Sendestationen in Großbritannien 
übernommene BBC-Skala verwendet Abstände 
von 4 dB zwischen den Skalenmarkierungen. 
Andere Organisationen wie EBU, CBC und ABC 
haben die gleiche Dynamik verwendet, jedoch mit 
leicht unterschiedlichen Skalen.

PPM Nordic (nur Pro Tools HD). – die 
skandinavische Variante von DIN PPM weist 
dieselben Integrations- und Rücklaufzeiten 
aber eine andere Skala auf, wobei „TEST“ dem 
Bezugspegel (0 dBu) und +9 der zulässige 
Maximalpegel (+9 dBu) entspricht. Verglichen 
mit der DIN-Skala ist die skandinavische Skala 
stärker logarithmisch und hat einen etwas 
kleineren Dynamikumfang.

PPM EBU (nur Pro Tools HD). – hierbei handelt es 
sich um eine Variante des britischen PPM zur 
Steuerung von Programmpegeln im internationalen 
Programmaustausch (Typ IIb PPM gemäß IEC 
60268-10). Mit Ausnahme der Pegelanzeige ist es 
mit British PPM (BBC) identisch. Die Pegelskala ist 
in dB relativ zum Bezugspegel kalibriert. Dieser ist 
mit „TEST“ gekennzeichnet. Die Markierungen 
sind in 2 dB-Intervallen und bei +9 dB (zulässiger 
Maximalpegel) angebracht.

PPM DIN (nur Pro Tools HD). – der Standard für 
den analogen Nennpegel, der dem zulässigen 
Maximalpegel entspricht, wurde vom deutschen 
Sender ARD mit 1,55 Volt (+ dBu) festgelegt. 
Dies ist die übliche Sensitivität eines DIN PPM bei 
einer Anzeige von 0 dB. Der Bezugspegel 
(–3 dBu) wird auf der Anzeige mit einem Strich 
bei –9 angezeigt.

K-12 (nur Pro Tools HD). – die K-Skalen sind 
RMS-basiert und enthalten eine integrierte 
Sample-Peak-Anzeige für einen zweiten Wert. 
K-Skalen sind beliebt bei Musikmixern, die eine 
aussagekräftige Darstellung der Gesamtlautheit 
wünschen. K-12 sollte ausschließlich für 
Tonübertragungen verwendet werden, obwohl 
Radioaufnahmetechniker auch K-14 wählen 
können, wenn es ihrer Meinung nach ihrem 
Programmmaterial entspricht.

K-14 (nur Pro Tools HD). – verwenden Sie K-14 
für das Mastering, wenn Sie mit einer kalibrierten 
Mastering-Suite arbeiten.
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K-20 (nur Pro Tools HD). – die Verwendung 
von K-20 beim Mixen trägt zu einem sauber 
klingenden Mix bei, was für den Mastering-
Techniker von Vorteil ist. Zu diesem Zeitpunkt 
sollten sich der Produzent und der Mastering-
Techniker einigen, ob das Programm in K-14 
konvertiert oder in K-20 belassen werden soll. 
Falls auf analoge Bänder gemischt wird, sollte 
mit K-20 gearbeitet werden. Dabei ist zu beachten, 
dass die Spitzenpegel vom Band den Wert von 
ungefähr +14 nicht überschreiten.

VENUE Peak. – bietet dieselben 
Ballistikeigenschaften wie Sample Peak, jedoch 
mit einer Skala bis +20 dB.

VENUE RMS. – bietet dieselben 
Ballistikeigenschaften wie RMS, jedoch mit einer 
VENUE-Skala bis +20 dB.

Advanced Meter 
Type-Einstellungen
Bei den Advanced Meter Type-Einstellungen 
können Sie die Skala und die Ballistikeigenschaften 
für den ausgewähltenMeter Type anpassen. Diese 
Einstellungen werden automatisch an die 
Spezifikationen des ausgewählten Meter Type 
angepasst. Bei einigen Systemkonfigurationen ist es 
sinnvoll, diese Einstellungen manuell anzupassen. 
So kann Pro Tools an die Reaktion Ihrer Broadcast-
Konsole angepasst werden (einige Broadcast-
Konsolen verwenden Abwandlungen der in 
Pro Tools enthaltenen Standard-Anzeigetypen). 
In den meisten Fällen sollten jedoch die 
Standardwerte für diese Einstellungen 
beibehalten werden.

Decay

Die Decay-Einstellungen bestimmen den 
Dezibelbereich (dBs), um den die Anzeige 
bei einer festgelegten Rate in Sekunden fällt, 
nachdem der Spitzenpegel erreicht wurde. 
Bei einigen Anzeigetypen können diese 
Einstellungen nicht angepasst werden (z. B. VU).

0 dBFS

Die 0 dBFS-Einstellung bestimmt den 
Referenzpegel für die Einheitsverstärkung 
der Anzeige in Dezibel im Vergleich zu 
0 dB (digital). Ein Überschreiten dieses Werts 
(oder der angegebenen Übersteuerungspegel bei 
Rundfunkübertragungen) sollte bei D/A-Wandlern 
zu einer Übersteuerung führen. Bei einigen 
Anzeigetypen können diese Einstellungen nicht 
angepasst werden (z. B. K-meters).

K-Skalen sind RMS-basiert und enthalten 
eine integrierte Sample-Peak-Anzeige für 
einen zweiten Wert. Weitere Angaben zum K-
Metering finden Sie im Artikel „An Integrated 
Approach to Metering, Monitoring, and 
Leveling Practices“ von Bob Katz, Digital 
Domain, Inc.



Kapitel 8: Preferences 123

Integrationszeit

Die Integration Time-Einstellung bestimmt die 
Zeit in Millisekunden, die durchschnittlich zum 
Erreichen des auf der Messanzeige angezeigten 
Spitzenpegels erforderlich ist. Dies kann als die 
Attack-Zeit für die Messung der Spitzenpegel auf 
den Anzeigen angesehen werden. Bei einigen 
Anzeigetypen können diese Einstellungen nicht 
angepasst werden (z. B. Peak).

Color Break High

Die Einstellung Color Break High bestimmt den 
höchsten Punkt in dB, an dem die Farbe der 
Anzeige wechselt. Dies ist normalerweise der 
Maximalpegel für den derzeit verwendeten Meter 

Type. Beim Überschreiten dieses Pegels kommt 
es üblicherweise zu einer Übersteuerung. Pegel, 
die auf den Anzeigen zwischen Color Break High 
und Color Break Low angezeigt werden, gelten im 
Hinblick auf die Lautstärke des Programms als 
idealer Bereich (Sweet Spot).

Color Break Low

Die Color Break Low-Einstellung bestimmt den 
tiefsten Punkt in dB, an dem die Farbe der Anzeige 
wechselt. Dies ist normalerweise der Mindestpegel 
für den derzeit verwendeten Meter Type. Verwenden 
Sie diese Einstellung, um auf der Messanzeige den 
niedrigsten Pegel des Dynamikbereichs für das 
gewünschte Material (z. B. Film, DVD, CD, MP3 
oder Rundfunkübertragungen) visuell darzustellen.

Reset

Klicken Sie auf Reset, um die Voreinstellungen 
unter „Advanced Meter Type“ auf die 
Standardeinstellungen für den gewählten Meter 

Type zurückzusetzen.

Peak/Clip-Abschnitt

Peak Hold-Optionen

Mit diesen Optionen legen Sie fest, wie lange 
nach der Erkennung eines Spitzenpegels die 
Spitzenwertanzeigen auf den Spuranzeigen 
noch aufleuchten. 

3 Seconds. – ist diese Option aktiviert, zeigen 
die Spuranzeigen den letzten Spitzenpegel drei 
Sekunden lang an.

Infinite. – ist diese Option aktiviert, zeigen die 
Spuranzeigen den letzten Spitzenpegel so lange an, 
bis Sie darauf klicken, um ihn zu löschen.

None. – ist diese Option aktiviert, leuchten die 
Spuranzeigen nur in dem Moment auf, in dem ein 
Spitzenpegel auftritt.

Clip Indication-Optionen

Mit diesen Optionen legen Sie fest, wie lange nach 
der Erkennung eines Übersteuerungswerts die 
Übersteuerungsanzeigen auf den Plug-In-, Send- 
und Spuranzeigen noch aufleuchten.

3 Seconds. – ist diese Option aktiviert, zeigen die 
Anzeigen die letzte Übersteuerung drei Sekunden 
lang an.

Infinite. – ist diese Option aktiviert, zeigen die 
Anzeigen die letzten Übersteuerungen so lange an, 
bis Sie darauf klicken, um sie zu löschen.

None. – ist diese Option aktiviert, wird die 
Übersteuerungsanzeige nach dem Erkennen des 
Übersteuerungswerts nicht mehr angezeigt.
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Display-Abschnitt
Der Anzeigebereich der Metering-
Voreinstellungen enthält Optionen zum 
Konfigurieren der neuen Gain-Reduction-
Anzeigen für Spuren und Sends.

Show Send Assignment Level Meter

Aktivieren Sie die Show Send Assignment Level 

Meter-Option , um die Pegelanzeige für die Send-
Zuweisung im Mix-Fenster für Audio-, Auxiliary-
Eingangs- und Instrumentenspuren anzuzeigen. 
Ist die Option deaktiviert, werden Pegelanzeigen 
unter Send-Zuweisungen für Spuren 
nicht angezeigt.

Show Track Gain Reduction Meter 

(Nur Pro Tools HD)

Aktivieren Sie die Show Track Gain Reductions 

Meter-Option, um die Gain-Reduction-Anzeige für 
die Spur im Mix-Fenster für Audio-, Auxiliary-
Eingangs-, Instrumenten- und Master-Fader-Spuren 
anzuzeigen. Dabei ist zu beachten, dass auch bei 
aktivierter Option Gain-Reduction-Anzeigen nur 
auf Spuren angezeigt werden, auf denen ein 
unterstütztes dynamisches Plug-In eingeschleift ist. 
Ist die Option deaktiviert, werden Gain-Reduction-
Anzeigen für Spuren nicht angezeigt.

Show Insert Assignments 
Gain Reduction Meter

(Nur Pro Tools HD)

Aktivieren Sie die Show Insert Assignment 

Gain Reductions Meter -Option, um die Gain-
Reduction-Anzeige für die Insert-Zuweisung 
der Spur im Mix-Fenster für Audio-, Auxiliary-
Eingangs-, Instrumenten- und Master-Fader-Spuren 
anzuzeigen. Dabei ist zu beachten, dass auch bei 
aktivierter Option Gain-Reduction-Anzeigen nur 

auf Spuren angezeigt werden, auf denen ein 
unterstütztes dynamisches Plug-In eingeschleift ist. 
Ist die Option deaktiviert, werden Gain-Reduction-
Anzeigen für Insert-Zuweisungen nicht angezeigt.

Gain Reduction Meter Type

(Nur Pro Tools HD)

Die Einstellungen unter Gain Reduction 

Meter Type bestimmen, bei welchen 
Dynamikverarbeitungs-Plug-Ins die Gain-
Reduction-Anzeige im Mix-Fenster für Audio-
, Auxiliary-Eingangs-, Instrumenten- und 
Master-Fader-Spuren angezeigt werden. Dabei 
ist zu beachten, dass sogar Gain-Reduction-
Anzeigen nur für Spuren angezeigt werden, 
auf denen ein unterstütztes dynamisches 
Plug-In eingeschleift ist.

Compressor/Limiter. – ist diese Option 
ausgewählt, wird nur die mit Hilfe von 
Kompressor/Limiter-Plug-Ins auf eine Spur 
angewendete Gain-Reduktion in der Gain-
Reduction-Anzeige angezeigt.

Expander/Gate. – ist diese Option ausgewählt, 
wird nur die mit Hilfe von Expander/Gate-Plug-
Ins auf eine Spur angewendete Gain-Reduktion in 
der Gain-Reduction-Anzeige angezeigt.

Priority Compressor/Limiter. – ist diese Option 
ausgewählt, wird, falls ein Kompressor/Limiter 
auf einer Spur eingeschleift ist, nur die Gain-
Reduktion von Kompressor/Limiter-Plug-Ins in 
der Gain-Reduction-Anzeige angezeigt. Ist 
hingegen kein Kompressor/Limiter-Plug-In auf 
einer Spur vorhanden, wird die Gain-Reduction 
von sämtlichen anderen Dynamikverarbeitungs-
Plug-Ins für diese Spur angezeigt.
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Priority Expander/Gate. – ist diese Option 
ausgewählt, wird, falls ein Expander/Gate auf 
einer Spur eingeschleift ist, nur die Gain-
Reduction von Expander/Gate-Plug-Ins in der 
Gain-Reduction-Anzeige angezeigt. Ist hingegen 
kein Expander/Gate-Plug-In für eine Spur 
vorhanden, wird die Gain-Reduktion von 
sämtlichen anderen Dynamikverarbeitungs-Plug-
Ins für diese Spur angezeigt.

All – Summed. – ist diese Option ausgewählt, wird 
in der Gain-Reduction-Anzeige die Summe aller 
Gain-Reduktionen angezeigt, die von Dynamik-
Plug-Ins auf eine Spur angewandt werden.

Processing-Voreinstellungen

AudioSuite-Abschnitt

Default Handle Length

Mit den Default Handle Length-Optionen können 
Sie die Standardlänge für AudioSuite- und Clip-
Gain-Handles festlegen.

Whole-File. – wenn diese Option aktiviert ist, 
rendern AudioSuite- und Clip-Gain-Rendering 
die gesamte Datei, die durch die Selektion oder 
den Clip referenziert wird. 

Length. – mit dieser Einstellung können Sie die 
Standard-Handle-Länge (von 0,00 bis 60,00 
Sekunden) für AudioSuite- und Clip-Gain-
Rendering festlegen. AudioSuite- und Clip-Gain-
Rendering rendert die Selektion sowie zusätzliches 
Audio bis zur festgelegten Handle-Länge.
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Import-Abschnitt
Convert Imported “WAV” Files To 
AES31/BroadcastWave. – wenn diese Option 
aktiviert ist, ist sie für alle importierten WAV-
Dateien wirksam und gewährleistet die 
Kompatibilität mit dem AES31/EBU-Standard.

Automatically Copy Files on Import. – wenn 
diese Option aktiviert ist, werden alle per Drag & 
Drop importierten Audiodateien in den Audio 
Files-Ordner der aktuellen Session gespeichert, 
unabhängig davon, ob sie zum Dateityp, der 
Bittiefe oder der Samplerate der aktuellen Session 
konvertiert werden müssen. Zusätzlich wird bei 
aktivierter Option im Import Session Data-
Dialogfeld automatisch die Copy from Source 

Media-Option aktiviert. Die Automatically Copy 

Files on Import-Voreinstellung hat keine 
Auswirkungen auf den Import Audio-Befehl.

Convert Copied Files to Session Format. – wenn 
diese Option ausgewählt ist, werden Dateien mit 
vom aktuellen Session-Dateiformat abweichenden 
Dateiformaten kopiert und beim Importieren in das 
aktuelle Session-Audiodateiformat umgewandelt. 
Wenn beispielsweise das Session-Dateiformat 
WAV ist und Sie ein AIF-Format importieren, 
werden die Dateien beim Importieren kopiert und 
in WAV umgewandelt. Wenn diese Option nicht 
ausgewählt ist, behalten kopierte Dateien ihr 
ursprüngliches Format bei (solange dieses 
Dateiformat mit Pro Tools kompatibel ist; 
andernfalls muss es umgewandelt werden).

Do Not Convert Sample Rate on Import. – wenn 
diese Option ausgewählt ist, werden Dateien 
mit von der Session-Samplerate abweichenden 
Samplerates beim Importieren in die Session nicht 
automatisch umgewandelt. Dies bedeutet, dass 
Dateien mit nicht übereinstimmenden Samplerates 
mit unterschiedlicher Geschwindigkeit 
wiedergegeben werden (und die Tonhöhe 
im Vergleich zur ursprünglichen Aufnahme 
(oder Umwandlung) ändert sich).

Import REX Files as Clip Groups. – bei Auswahl 
dieser Option werden REX-Dateien als 
Clipgruppen importiert. Alle zugrunde liegenden 
Slices werden als individuelle Clips innerhalb der 
Clipgruppe importiert. Wenn diese Option nicht 
ausgewählt ist, werden REX-Dateien beim Import 
in eine Session in das Audiodateiformat der 
Session konvertiert. Die individuellen Slices 
werden konsolidiert und die Slice-Informationen 
dienen als Informationen für die Elastic Audio-
Analyse. Diese Dateien sind auch nach Import und 
Konvertierung Tick-basiert. 

Automatically Create Fades. – ist diese Option 
aktiviert, werden automatisch Crossfades auf 
die in Slices unterteilten Clips innerhalb der 
Clipgruppen angewendet, die durch den Import 
der REX-Dateien erstellt wurden. Wenn die Import 

REX Files as Clip Groups-Option nicht aktiviert 
ist, steht die Automatically Create Fades-Option 
nicht zur Verfügung. 

Klicken Sie zum Ändern der Standard-Fade-
Einstellungen von REX-Dateien im Default Fade 
Settings-Abschnitt in den Editing-Voreinstellungen 
auf die REX-Schaltfläche.

Drag and Drop From Desktop Conforms to 
Session Tempo

Die Drag and Drop From Desktop Conforms to 

Session Tempo-Optionen legen fest, ob Dateien 
im REX-, ACID- oder in einem anderen 
Audiodateiformat als Tick-basierte Elastic Audio-
Dateien importiert und an das Session-Tempo 
angeglichen werden.

No Files. – wenn diese Option aktiviert ist, werden 
alle Audiodateien einschließlich REX- und ACID-
Dateien beim Importieren per Drag & Drop aus 
dem Windows Explorer oder Mac Finder nicht an 
das Session-Tempo angeglichen. Sie werden als 
samplebasierte Dateien importiert und in das 
Audiodateiformat der Session konvertiert.
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REX and ACID Files Only. – wenn diese Option 
aktiviert ist, werden nur REX- und ACID-Dateien 
beim Importieren per Drag & Drop aus dem 
Windows Explorer oder Mac Finder an das 
Session-Tempo angeglichen. REX-Dateien 
werden entweder als tickbasierte Elastic Audio-
Dateien oder (falls die Import REX Files as Clip 
Groups-Option aktiviert ist) als tickbasierte 
Clipgruppen importiert. 

All Files. – wenn diese Option aktiviert ist, werden 
alle Audiodateien einschließlich REX- und ACID-
Dateien beim Importieren per Drag & Drop aus 
dem Windows Explorer oder Mac Finder als 
tickbasierte Elastic Audio-Dateien importiert 
und an das Session-Tempo angeglichen.

Sample Rate Conversion Quality

Über das Sample Rate Conversion Quality-Popup-
Menü können Sie die standardmäßige Qualität der 
Samplerate-Konvertierung beim Importieren 
von Audiodateien per Drag & Drop aus einem 
Workspace-Browser, Windows Explorer oder 
Mac Finder auswählen. Je höher die gewählte 
Konvertierungsqualität der Samplerate, desto 
mehr Zeit benötigt Pro Tools für die Verarbeitung 
der Audiodatei.

TC/E (Time Compression/
Expansion-Abschnitt
TC/E Plug-In. – ermöglicht die Auswahl des Plug-
Ins, das für Time Compression/Expansion 
verwendet wird, wenn Sie Audiomaterial mit 
dem Time Compression/Expansion Trim-Tool 
bearbeiten. Dieses Trim-Tool passt einen Audio-
Clip durch Zeitkomprimierung bzw. -expansion an 
die Länge eines anderen Clips, an ein Temporaster, 
eine Videoszene oder eine andere Bezugsgröße 
an Das Time Shift-Plug-In ist standardmäßig 
ausgewählt.

Default Settings. – bestimmt die Standarde-
instellungen, die vom gewählten Time Compression/ 
Expansion-Plug-In verwendet werden.

Elastic Audio-Abschnitt
Diese Voreinstellungen legen die Elastic Audio-
Verwendung und -Einstellungen auf neuen Spuren 
sowie für das Abhören und den Import tickbasierten 
Audiomaterials fest.

Default Plug-In. – mit dieser Option können 
Sie jedes Real-Time Elastic Audio-Plug-In als 
Standard-Plug-In für das Abhören und Importieren 
von Elastic Audio verwenden. Das ausgewählte 
Elastic Audio-Standard-Plug-In wird auch 
verwendet, wenn neue Spuren mit aktivierter 
Enable Elastic Audio on New Tracks-Option 
erstellt werden. 

Default Input Gain. – hier können Sie den 
Signaleingang für Elastic Audio-Plug-Ins um 
0 bis –6 dB für die Vorschau und den Import 
dämpfen. Wenn aufgrund der Elastic Audio-
Bearbeitung während der Vorschau oder nach 
dem Import eine Übersteuerung auftritt, sollten 
Sie die Default Input Gain-Option so einstellen, 
dass der Audiosignaleingang für die Elastic Audio-
Bearbeitung leicht abgeschwächt wird. Diese 
Einstellung gilt auch für Audiomaterial, das in eine 
Elastic Audio-fähige Spur importiert wird.

Das Elastic Properties-Fenster übernimmt die 
Einstellung der Default Input Gain-Option. Um 
eine weitere clipbasierte Input Gain-Dämpfung 
für die Elastic Audio-Bearbeitung anzuwenden, 
wählen Sie den Clip aus und passen Sie die Input 
Gain-Einstellung im Elastic Properties-Fenster 
an (siehe „Elastic Properties-Fenster“ auf 
Seite 927).

Enable Elastic Audio on New Tracks. – wenn 
diese Option ausgewählt ist, werden neue Spuren 
mit aktiviertem Elastic Audio erstellt. Das 
ausgewählte Elastic Audio-Standard-Plug-In 
wird verwendet.

Wenn die Enable Elastic Audio on New 
Tracks-Option ausgewählt ist, können Sie 
auch die New Tracks Default to Tick 
Timebase-Option in den Editing-
Voreinstellungen auswählen.
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DSP Management-Abschnitt
(Nur Pro Tools|HDX-Systeme)

Mit diesen Voreinstellungen wird die DSP-
Verwaltung beim Konvertieren von DSP-Plug-
Ins in Native sowie für die HEAT-Softwareoption 
festgelegt.

Open Unresourced DSP Plug-Ins as Native. – ist 
diese Option aktiviert, werden DSP-Plug-Ins, 
die die verfügbare DSP-Verarbeitungsleistung 
überschreiten, nach Möglichkeit in das Native-
Format konvertiert. Ist diese Option deaktiviert, 
werden DSP-Plug-Ins, die die verfügbare DSP-
Verarbeitungsleistung überschreiten, 
inaktiv gesetzt. 

Enable HEAT in New Sessions (nur 
Pro Tools|HDX Systems). – wenn diese Option 
aktiviert ist, werden neue Spuren so erstellt, dass 
sie HEAT-fähig sind. Ist die Option deaktiviert, 
wird HEAT in neuen Sessions standardmäßig 
deaktiviert. Diese Option ist nur verfügbar, 
wenn die HEAT-Softwareoption installiert ist. 
Weitere Informationen hierzu finden Sie im 
HEAT-Handbuch.

MIDI-Voreinstellungen

Basics-Abschnitt
Remove Range Selection After Opening the 
MIDI/Score Editor. – wenn diese Option aktiviert 
ist, werden der MIDI Editor und der Score Editor 
ohne Edit-Selektion geöffnet. Ist diese Option 
deaktiviert, werden der MIDI Editor und der Score 
Editor mit der aktuellen Edit-Selektion geöffnet.

Use MIDI to Tap Tempo. – wenn diese Option 
aktiviert ist, können Sie neue Tempowerte über ein 
MIDI-Keyboard in ein Tempofeld eingeben.

Display Events as Modified by Real-Time 
Properties. – wenn diese Option aktiviert ist, zeigt 
Pro Tools die Auswirkungen von Echtzeit-
Eigenschaften sowohl im Edit-, MIDI Editor- und 
Score Editor-Fenster als auch in der MIDI Event-
Liste an.

Use F11 Key for Wait for Note. – wenn diese 
Option aktiviert ist, versetzen Sie die MIDI-
Aufnahme durch Drücken der Funktionstaste 
F11 in den Wait for Note-Modus. 



Kapitel 8: Preferences 129

Automatically Create Click Track in New 
Sessions. – wenn diese Option aktiviert ist, 
erstellt Pro Tools in neuen Sessions automatisch 
eine neue Click-Spur.

Default Thru Instrument

Mit dieser Option können Sie das standardmäßige 
MIDI Thru-Instrument festlegen. Sie können 
unter den verfügbaren MIDI-Instrumenten ein 
vordefiniertes Gerät oder First Selected MIDI Track 
wählen, um den MIDI-Ausgang zu verwenden, 
der dem ersten ausgewählten MIDI- oder der 
Instrumentenspur zugewiesen ist. Sind mehrere 
MIDI- oder Instrumentenspuren ausgewählt, 
wird das Instrument in der ausgewählten Spur 
verwendet, die sich an oberster Stelle im Edit-
Fenster bzw. am weitesten links im Mix-Fenster 
befindet. Wählen Sie None, um nur mit MIDI Thru 
für die Aufnahme scharfgeschaltete MIDI- und 
Instrumentenspuren zu routen.

Pencil Tool Resolution When Drawing 
Controller Data

Mit dieser Option können Sie die 
Standardauflösung für MIDI-Controller-Daten 
einstellen, die mit dem Pencil erstellt werden. 
Wenn Sie eine niedrigere Auflösung wählen, 
vermeiden Sie das Erstellen unnötig dichter 
Controller-Daten. Dieser Wert kann zwischen 
1 und 100 Millisekunden liegen.

Global MIDI Playback Offset

Mit dieser Option können Sie einen Offset-Wert 
(in Samples) für den Ausgleich von MIDI-
Latenzen festlegen. Die Eingabe eines Werts in 
dieses Feld führt zum gleichen Ergebnis wie das 
Einstellen eines Offsets mit dem MIDI Track 

Offsets-Befehl. Der Offset-Wert kann positiv 
(später) oder negativ (früher) sein. 

Double-Clicking a MIDI Clip Opens

Mit dieser Option können Sie angeben, was beim 
Doppelklicken auf MIDI-Clips mit dem Grabber-
Tool geschieht. 

MIDI-Editor. – öffnet den MIDI-Clip in einem 
MIDI Editor-Fenster.

Noten-Editor. – öffnet den MIDI-Clip im Score 
Editor-Fenster.

MIDI Event List. – öffnet den MIDI-Clip in der 
MIDI Event-Liste.

Name Dialog. – öffnet das Name-Dialogfeld für 
den MIDI-Clip.
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Note Display-Optionen
Mit diesen Optionen wird der Referenzton für das 
eingestrichene C mit C3, C4 oder MIDI-Note 
Nummer 60 eingestellt.

Delay Compensation for 
External Devices-Optionen
Diese Optionen stehen nur zur Verfügung, wenn 
in der Playback Engine eine Delay Compensation 

Engine gewählt wurde und Delay Compensation in 
Pro Tools aktiviert ist. Diese Optionen unterscheiden 
sich von den Hardware-Offsets, die für Hardware-
Inserts im I/O-Setup zur Verfügung stehen.

MIDI Timecode. – wenn diese Option aktiviert ist, 
wendet Pro Tools den Verzögerungsausgleich auf 
den von Pro Tools erzeugten MIDI-Timecode 
(MTC) an. Aktivieren Sie diese Option, wenn 
Sie in Pro Tools Video mithilfe von MTC 
synchronisieren.

MIDI Beat Clock. – wenn diese Option aktiviert ist, 
wendet Pro Tools den Verzögerungsausgleich auf 
die von Pro Tools erzeugten MIDI Beat Clock-
Signale an.

MIDI Notes and Controllers. – wenn diese 
Option aktiviert ist, wendet Pro Tools den 
Verzögerungsausgleich auf MIDI-Noten und 
MIDI-Controllerdaten an. Dies ist hilfreich beim 
Playback-Monitoring oder beim Aufnehmen von 
Eingangssignalen von externen MIDI-Geräten.

MIDI/Score Editor Display

Additional Empty Bars in the Score Editor

Mit dieser Einstellung können Sie die 
Standardanzahl leerer Takte angeben, die im Score 
Editor-Fenster am Ende des letzten MIDI-Clips in 
der Session angezeigt werden.

Synchronization-
Voreinstellungen

Machine Control-Abschnitt
Machine Chases Memory Location. – wenn diese 
Option aktiviert ist, bewirkt das Navigieren an eine 
bestimmte Position in einer Session mithilfe einer 
Memory Location, dass das über die Maschine 
angesprochene Gerät ebenfalls diese Position anfährt.

Machine Follows Edit Insertion/Scrub. – wenn 
diese Option aktiviert ist, bewirkt das Navigieren 
an eine bestimmte Position in einer Session durch 
Verschieben des Auswahlpunkts oder mithilfe der 
Scrubbing-Funktion, dass das über die Maschine 
angesprochene Gerät ebenfalls diese Position anfährt.

Wenn das angeschlossene Gerät ein lineares Gerät 
(etwa eine Bandmaschine) ist, wählen Sie Linear 

Devices (jog), um Pro Tools für das Senden von 
Jog-Befehlen einzustellen.



Kapitel 8: Preferences 131

Wenn das angeschlossene Gerät ein nichtlineares 
Gerät (etwa ein Videorekorder mit direktem 
Bearbeitungszugriff oder ein anderes Pro Tools-
System) ist, wählen Sie Non-Linear Devices (cue) 
aus, um Pro Tools für das Senden von Cue-
Befehlen einzustellen.

Machine Cues Intelligently (nur Pro Tools|HDX- 
und Pro Tools|HD Native-Systeme). – wenn diese 
Option aktiviert ist und Sie zu einem Cue-Punkt 
navigieren, der mehr als 10 Sekunden von der 
aktuellen Position entfernt ist, steuert Pro Tools 
das verbundene Gerät so, dass es den Cue-Punkt 
bis 10 Sekunden vor der Position mit voller 
Geschwindigkeit anfährt. Anschließend wird die 
Geschwindigkeit bis zum Erreichen des Punkts auf 
die normale Geschwindigkeit reduziert. Dadurch 
kann in bestimmten Fällen das Cueing bei 
Bandmaterial erheblich beschleunigt werden.

Stop at Shuttle Speed Zero (nur Pro Tools|HDX- 
und Pro Tools|HD Native-Systeme). – durch 
Aktivieren dieser Option sendet Pro Tools einen 
Stop-Befehl, wenn Sie das Shuttling beenden. 
Dies ist besonders nützlich bei Geräten, die zum 
korrekten Anhalten einen ausdrücklichen Stop-
Befehl benötigen. 

Non-Linear Transport Error Suppression 
(nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme). – wenn Transport = Pro Tools 
eingestellt ist, sendet Pro Tools keinen Stop-
Befehl, wenn es offline geschaltet wird. Hiermit 
wird vermieden, dass Pro Tools andere mit dem 
System verbundene 9-Pin-Geräte anhält.

Synchronization-Abschnitt
Minimum Sync Delay. – mit dieser Option wird die 
anfängliche Prime-Zeit (in Frames) eingestellt, 
die alle Geräte in Ihrem System benötigen, um sich 
auf die Synchronisation einzulocken. Dieser Wert 
variiert je nach Gerät. In Pro Tools wird diese 
Verzögerungszeit durch Eingabe eines Werts 
im Minimum Sync Delay-Feld in den 
Synchronization-Voreinstellungen eingestellt. 
Der niedrigste Wert ist 15 Frames. Sie sollten 
die kürzeste Verzögerungszeit ermitteln, mit der 
Ihre Geräte einwandfrei arbeiten können, und sie 
ins Minimum Sync Delay-Feld eingeben. 
Bei Systemen mit MachineControl lässt sich die 
Verzögerungszeit drastisch verkürzen, wenn die 
Use Serial Timecode-Option aktiviert ist. 
(Für den seriellen Timecode müssen sowohl ein 
qualifiziertes Synchronisations-Peripheriegerät als 
auch externe Geräte auf die studioweite 
Videoreferenz eingelockt sein.)

Delay Before Locking to Longitudinal Timecode 
(nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme). – legt die Dauer (in Frames) fest, 
die Pro Tools für das Einlocken auf das eingehende 
LTC-Signal benötigt. Verwenden Sie diese Option, 
wenn Pro Tools auf den Timecode einer stabilen 
Quelle (wie einem nicht linearen Bandgerät oder 
einem LTC-Generator), nicht eines linearen 
Bandgeräts, einlocken soll.

Delay Before Locking to Serial Timecode 
(nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme). – legt die Zeitdauer (in Frames) fest, 
die Pro Tools wartet, bevor das Einlocken bei 
Geräten versucht wird, die Servo Lock-Meldungen 
ausgeben. Mit dieser Einstellung wird bei Servo-
Mechanismen Zeit für ein stabiles Einlocken 
eingeplant.
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Remote Mode-Abschnitt
(Nur Pro Tools|HDX- und 
Pro Tools|HD Native-Systeme)

Ignore Track Arming. – mit dieser Option ignoriert 
Pro Tools eingehende Befehle zur Scharfschaltung 
von Spuren. Dies ist hilfreich, wenn Sie mithilfe eines 
Master Controllers Spuren auf anderen Geräten, 
jedoch nicht in Pro Tools, scharfschalten möchten.

Set Servo Lock Bit at Play. – aktivieren Sie 
diese Option, wenn Sie einen Synchronizer zur 
Steuerung von Pro Tools im Remote-Modus 
verwenden, um Einlockzeiten während der 
Aufnahme zu minimieren.

Allow 9-Pin Track Arm Commands in Local 
Mode. – mit dieser Option reagiert Pro Tools 
auf eingehende Scharfschaltungsbefehle für 
Spuren auch dann, wenn sich das System nicht 
im Remote-Modus befindet. Dies ist hilfreich, 
wenn Sie ein Paddle-Gerät zur Steuerung der 
Spur-Scharfschaltung oder zum Punching in 
Pro Tools nutzen. 

Allow 9-Pin Transport Commands in Local Mode. 
– mit dieser Option reagiert Pro Tools auf 
eingehende Transportbefehle auch dann, 
wenn sich das System nicht im Remote-Modus 
befindet. Dies ist hilfreich, wenn Sie Satellite 
Link zusammen mit einem 9-Pin-Controller 
verwenden. Sie können die Transportbefehle 
vom 9-Pin-Controller empfangen, jedoch ohne 
die für ein 9-Pin-Gerät typische Verzögerung.

Punch In Frame Offset. – hiermit stellen Sie einen 
Wert (in Frames) für eine zeitliche Verschiebung 
des Punch-In-Punkts ein, um Timing-Probleme 
auszugleichen.

Punch Out Frame Offset. – hiermit stellen 
Sie einen Wert (in Frames) für eine zeitliche 
Verschiebung des Punch-Out-Punkts ein, 
um Timing-Probleme auszugleichen.

Delay After Play Command. – hiermit stellen Sie 
die Zeitdauer (in Frames) ein, die Pro Tools nach 
dem Empfang eines Play-Befehls wartet, bevor es 
die Audio-Engine startet. Dadurch können 
Fehlstarts beim Einlocken auf Synchronizer, 
die von Pro Tools nicht voll unterstützt werden, 
vermieden werden.

Satellites-Abschnitt
(Nur Pro Tools|HDX- und Pro Tools|HD 
Native-Systeme)

Mit der Satellite Link-Option können Sie bis 
zu 12 Pro Tools HD-Systeme – oder bis zu 
11 Pro Tools HD-Systeme und ein Avid Video 
Satellite-System (Media Composer oder Avid 
Symphony Nitris DX®) oder ein Pro Tools Video 
Satellite-System – über ein Ethernet-Netzwerk 
miteinander verbinden, sodass Sie Material über 
jede beliebige der miteinander verbundenen 
Workstations ansteuern und wiedergeben und die 
Wiedergabe beenden, Wiedergabe-Selektionen 
treffen und Spuren auf jedem der Systeme solo 
schalten können.

Transmit Solos. – führt dazu, dass ein gekoppeltes 
Pro Tools-System den Solo-Status der Spuren 
an alle anderen gekoppelten Pro Tools-Systeme 
sendet. Auf anderen gekoppelten Systemen, die für 
den Empfang des Solo-Status eingerichtet sind, 
folgen die Spuren der Solo-Funktion, als würde die 
Solo-Schaltung auf dem lokalen System erfolgen. 

Receive Solos. – führt dazu, dass ein gekoppeltes 
Pro Tools-System den Solo-Status aller anderen 
gekoppelten Pro Tools-Systeme empfängt, die für 
die Übertragung des Solo-Status ihrer Spuren 
eingerichtet sind. Spuren im empfangenden 
System folgen der Solo-Funktion, als würde die 
Solo-Schaltung auf dem lokalen System erfolgen. 
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Solo Independent of Linked State. – führt dazu, 
dass ein Pro Tools-System den Solo-Status der 
Spuren an andere Satellitensysteme sendet, auch 
wenn keine Kopplung besteht. So kann der Solo-
Status systemübergreifend gesteuert werden, auch 
wenn die Transport-Steuerung nicht aktiviert ist. 

AAE Errors Stop All Linked Systems. – führt 
dazu, dass ein AAE-Fehler auf einem gekoppelten 
Pro Tools-System den Transport auf allen 
gekoppelten Systemen anhält. Ist diese Option 
nicht ausgewählt, werden bei einem AAE-Fehler 
in einem System die gekoppelten Systeme 
nicht angehalten. 

Transmit Play Selections. – führt dazu, dass 
ein gekoppeltes Pro Tools-System die Selektion 
im Edit-Fenster an alle anderen gekoppelten 
Pro Tools-Systeme sendet. Auf anderen 
gekoppelten Systemen, die für den Empfang 
der Wiedergabe-Selektion eingerichtet sind, 
wird die Auswahl im Edit-Fenster gespiegelt.

Receive Play Selections. – führt dazu, dass ein 
gekoppeltes Pro Tools-System die Auswahl im 
Edit-Fenster von allen anderen gekoppelten 
Pro Tools-Systemen empfängt, die für die 
Übertragung der Wiedergabe-Selektion 
eingerichtet sind.

Globale und lokale 
Voreinstellungen
Pro Tools-Voreinstellungen sind entweder global 
(systemweit) oder lokal (nur für die aktuelle 
Session) gültig. 

Globale (systemweite) Voreinstellungen. – gelten 
für alle Sessions. Diese Voreinstellungen werden 
als Standard-Voreinstellungen für alle bestehenden 
Sessions, die Sie öffnen, sowie alle neu erstellten 
Sessions genutzt.

Lokale Voreinstellungen (aktuelle Session). – 
gelten nur für die aktuelle Session (sofern eine 
geöffnet ist). Sie gelten nicht für ältere Sessions, 
die später geöffnet werden.

Voreinstellungen und neue Sessions

Neue Sessions verwenden globale Voreinstellungen 
sowie die aktuellsten lokalen Voreinstellungen. Die 
aktuellsten lokalen Einstellungen beziehen sich auf 
die zuletzt geöffnete Session (sofern im weiteren 
Verlauf keine Änderungen im Preferences-
Dialogfeld des Anwendungsfensters 
vorgenommen wurden).

Lokale Voreinstellungen 
(nur Session)
Alle Voreinstellungen sind global (systemweit), 
mit Ausnahme der folgenden, lokalen 
Voreinstellungen:

• Anzeige-Voreinstellungen (Display)

• Standardlänge des Edit-Fensters

• Always Display Marker Colors

• Default Track Color Coding-Optionen

• Default Clip Color Coding-Optionen

• Betriebs-Voreinstellungen (Operation)

• Custom Shuttle Lock Speed

• Back/Forward Amount (nur Pro Tools HD)
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• PEC/Direct Style Input Monitoring 
(nur Pro Tools HD)

• DestructivePunch File Length 
(nur Pro Tools HD)

• Clip Auto Fade In/Out Length 
(nur Pro Tools HD)

• Delay Comp Time Mode

• Compensate side chains 
(nur Pro Tools|HDX-Systeme)

• Editing-Voreinstellungen

• None

• Mixing-Voreinstellungen

• Coalesce When Removing Slaves from VCA 
Group (nur Pro Tools HD)

• Metering-Voreinstellungen

• None

• Processing-Voreinstellungen

• Convert Imported „WAV“ Files To 
AES31/BroadcastWave

• MIDI-Voreinstellungen

• Display Events as Modified by Real-
Time Properties

• Automatically Create Click Track in 
New Sessions

• Default Thru Instrument

• Pencil Tool Resolution When Drawing 
Controller Data

• Delay for External Devices Options

• Synchronisations-Voreinstellungen

• None
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Kapitel 9: Peripheriegeräte

Mit den Einstellungen im Peripherals-Dialogfeld 
können Sie definieren, wie Pro Tools mit 
verschiedenen Audio-, Synchronisations- und 
Controller-Geräten und VENUE-Systemen arbeitet.

So konfigurieren Sie die Einstellungen für 
Pro Tools-Peripheriegeräte:

1 Wählen Sie Setup > Peripherals.

2 Klicken Sie auf die Registerkarte für den 
Peripherietyp, den Sie konfigurieren möchten. 

3 Ändern Sie die Einstellungen.

4 Klicken Sie auf OK, um die Änderungen 
zu speichern und das Peripherals-Dialogfeld 
zu schließen.

Synchronisation
Auf der Synchronization-Registerkarte können 
Sie Pro Tools für die Nutzung mit MIDI-
Timecode-Geräten und Synchronisation-
speripherie konfigurieren.

Informationen zu Peripheriegeräten zur 
Synchronisation finden Sie im SYNC 
HD-Handbuch.
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MTC Reader und Generator
In den MIDI Timecode (MTC)-Einstellungen 
können Sie die MIDI-Ein- und Ausgänge für 
MTC auswählen.

MTC Reader Port. – mit der MTC Reader Port-
Einstellung können Sie den MIDI-Eingang 
auswählen, an dem das MTC Slave-Gerät 
angeschlossen ist (die Quelle der MTC-
Informationen des Slave-Geräts). 

MTC Generator Port. – mit der MTC Generator 

Port-Einstellung können Sie den MIDI-Ausgang 
auswählen, an dem das Master-Gerät angeschlossen 
ist (das Ziel der MTC-Informationen von 
Pro Tools).

Synchronization Device-
Einstellungen
(Nur Avid HDX- und HD Native-Systeme)

Über die Synchronization Device-Einstellungen 
können Sie ein Synchronisationsperipheriegerät 
wie etwa SYNC HD konfigurieren.

Enable SYNC Peripheral

Wenn diese Option aktiviert ist, sind sämtliche 
angeschlossenen Synchronisationsperipheriegeräte 
für die Verwendung mit Pro Tools aktiviert.

Current Firmware Version

Hier wird die Firmware-Version der 
angeschlossenen Synchronisationsperipherie, 
etwa eines SYNC HD, angezeigt.

VITC Insertion Enabled

Bei Auswahl dieser Option wird in das ausgehende 
Videosignal VITC eingefügt, vorausgesetzt, einer 
der Videoeingänge der Synchronisationsperipherie 
empfängt ein Videosignal und die Synchronisation-
speripherie befindet sich in einem Modus, in dem 
VITC eingefügt werden kann. 

Pitch Memory Enabled

Wenn diese Option aktiviert ist, behält die 
Synchronisationsperipherie die Tonhöhe 
(Samplerate) bei, die der letzten bekannten 
Geschwindigkeit von eingehendem Timecode 
entspricht. Ist die Option deaktiviert, verwendet 
die Synchronisationsperipherie wieder die 
ausgewählte Samplerate. Ist „Pitch Memory“ 
deaktiviert und der ausgewählte externe 
Taktgeber steht nicht zur Verfügung, verwendet 
die Synchronisationsperipherie wieder die 
ausgewählte nominale interne Samplerate.

Idle MTC Enabled

Wenn diese Option aktiviert ist, wird 
kontinuierlich MTC ausgegeben. Ist sie nicht 
aktiviert, wird die MTC-Ausgabe in inaktiven 
Phasen stumm geschaltet.

LTC Output Level

Diese Einstellung regelt den analogen Audiopegel 
des LTC-Outputs und liegt zwischen –24 dBu 
und +9 dBu.

VITC Read Lines

Diese Einstellung bestimmt, welches Zeilenpaar 
des eingehenden Videosignals als VITC-Quelle 
verwendet werden soll. Bei der Einstellung „Auto“ 
sucht die Synchronisationsperipherie automatisch 
das erste gültige Zeilenpaar. Alternativ dazu 
können Sie hier bestimmte VITC-
Zeilenpaare festlegen.

VITC Generate Lines

Diese Einstellung legt das Zeilenpaar des 
ausgehenden Videosignals fest, auf dem die 
Synchronisationsperipherie VITC einfügt. 
Normalerweise sollten Sie die (bevorzugte) 
Standardeinstellung 14/16 nicht ändern. 
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Bi-Phase/Tach Wiring

Mit dieser Einstellung können Sie aus den 
folgenden Optionen für die Bi-Phase- oder Tach-
Verkabelung wählen:

• Bi-Phase: FWD = A leads B

• Bi-Phase: Bi-Phase: FWD = B leads A

• Tach: FWD = B is Low

• Tach: FWD = B is High

Bi-Phase/Tach Pulses/Frame (2–254)

Für die Anzahl der Impulse pro Bild gibt es bei Bi-
Phase- oder Tach-Geräten verschiedene Standards. 
Sie können einstellen, dass die Synchronisation-
speripherie in Pro Tools zwischen 2 und 
254 Impulsen pro Bild arbeitet. Die Einstellung 
sollte der PPF-Rate des Bi-Phase/Tach-Encoders 
vom externen Gerät entsprechen.

Reset Bi-Phase

Mit dieser Schaltfläche können Sie das Bi-Phase-
/Tach-Start-Frame in Pro Tools einstellen. Durch 
Klicken auf die Schaltfläche wird die Timecode-
Anzeige der Synchronisationsperipherie 
entsprechend dem Timecode-Wert der 
Session aktualisiert.

Enable Dub Window

Wenn diese Option aktiviert ist, können Sie ein 
Timecode-Fenster in ein Videosignal einfügen, 
wobei die folgenden Darstellungseinstellungen für 
die Timecode-Markierung möglich sind: 

Vertical Position. – legt die vertikale Position 
der Timecode-Markierung relativ zum unteren 
Videobildrand fest. Der Auswahlbereich reicht 
von „10 % From Bottom“ bis „50 % From 
Bottom“ und kann in 10 %-Schritten erhöht oder 
verringert werden.

Horizontal Position. – legt die relative horizontale 
Position der Timecode-Markierung innerhalb des 
Videobilds fest. Sie haben die Auswahl zwischen 
„Extreme Left“, „Left“, „Center“, „Right“ und 
„Extreme Right“.

Size. – legt die relative Größe der Timecode-
Markierung fest („Small“ oder „Large“).

Color. – legt die Farbe der Ziffern und des 
Hintergrunds der Timecode-Markierung fest. 
Sie haben die Auswahl zwischen „White on Black 
Bkgnd“, „Black on White Bkgnd“, „White on 
Video Bkgnd“ und „Black on Video Bkgnd“. 
(Bei „Video Bkgnd“ ist der Hintergrund der 
Timecode-Markierung transparent, sodass die 
Timecode-Ziffern direkt über dem Videosignal 
erscheinen, ohne durch ein zusätzliches Fenster 
abgehoben zu sein.) Die Standardeinstellung ist 
„White on Black Bkgnd“.

Die vertikale Position „10 % from Bottom“ 
liegt außerhalb des standardmäßigen 
sicheren Bereichs für Titel, was bedeutet, 
dass die Timecode-Markierung auf einigen 
Videomonitoren möglicherweise nicht 
sichtbar ist.

Die horizontale Position „Extreme“ liegt 
außerhalb des standardmäßigen sicheren 
Bereichs für Titel, was bedeutet, dass 
die Timecode-Markierung auf einigen 
Videomonitoren möglicherweise nicht 
sichtbar ist.
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Maschinensteuerung
Auf der Machine Control-Registerkarte können Sie 
Pro Tools für die Nutzung mit MIDI Machine 
Control oder 9-Pin Machine Control konfigurieren.

MIDI Machine Control (Master)
Pro Tools bietet für die Konfiguration von MIDI 
Machine Control(Master)-Einstellungen folgende 
Optionen an:

Aktivieren Sie

Wenn die Enable-Option aktiviert ist, fungiert 
Pro Tools als Master, sendet MMC-Befehle an das 
Slave-Gerät und empfängt MTC-Informationen 
von diesem.

MIDI Out Port

Im MIDI Out Port-Popup-Menü können Sie den 
MIDI-Ausgang auswählen, an dem das Slave-
Gerät angeschlossen ist.

MMC ID

In der MMC ID-Einstellung können Sie die 
MMC-ID-Nummer angeben, für die MMC-
Informationen gesendet werden. MMC-Befehle 
enthalten eine ID-Nummer, die festlegt, welche 
Maschine mit dem MMC-Befehl angesprochen 
werden soll. Es gibt 128 MMC-ID-Nummern, 
von 0 bis 127. Die Standard-ID-Nummer 127 ist 
eine Spezialeinstellung, die an alle 128 MMC-
IDs sendet. Mit der Einstellung 127 sendet 
Pro Tools MMC-Befehle an alle MMC-IDs. 

Preroll

Mit der Pre-Roll-Einstellung können Sie eine 
Pre-Roll-Zeit in Frames für Ihr MMC-Slave-
Gerät festlegen. Der Vorlauf (Pre-Roll) ist 
notwendig, um dem Gerät genügend Zeit zu 
geben, sich auf den von Pro Tools übertragenen 
Timecode einzulocken. Der Wert dafür ist von 
Gerät zu Gerät verschieden. Wenn die 
Vorlaufzeit nicht ausreichend lang ist, kann das 
Gerät möglicherweise erst nach Passieren der 
aktuellen Timecode-Markierung einlocken.

MIDI Machine Control (Slave)
Pro Tools bietet für die Konfiguration von MIDI 
Machine Control(Slave)-Einstellungen folgende 
Optionen an:

Aktivieren Sie

Wenn die Enable-Option aktiviert ist, fungiert 
Pro Tools als Slave, empfängt MMC-Befehle vom 
Master-Gerät und sendet MTC-Informationen an 
das Slave-Gerät zurück.

MMC ID

Mit der MMC ID-Einstellung können Sie die 
MMC-ID-Nummer angeben, für die MMC-
Informationen empfangen werden.

Weitere Informationen zur MachineControl-
Softwareoption für Pro Tools finden Sie im 
MachineControl-Handbuch.
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9-Pin Machine Control 
(Deck Control)
(Nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme mit MachineControl)

Mit den 9-Pin Machine Control (Deck Control)-
Einstellungen können Sie ein Machine Control-Gerät 
für den Serial Deck Control-Modus in Pro Tools 
konfigurieren. Der Serial Deck Control-Modus ist 
immer verfügbar, wenn Machine-Control über das 
Serial Deck Control-Kabel verbunden ist. Bei einer 
Verbindung für den Serial Deck Control-Modus 
aktiviert Machine Control sämtliche Spur-
Scharfschaltungen sowie Synchronisations- und 
Transportfunktionen in Pro Tools, die in Ihrem 
System zur Verfügung stehen. Der Modus „Serial 
Deck Control“ unterstützt auch seriellen 9-Pin-
Timecode.

Aktivieren Sie

Wenn die Enable-Option aktiviert ist, befindet sich 
Pro Tools im Serial Deck Control-Modus.

Port

Mit der Port-Einstellung können Sie den 9-Pin 
MachineControl-Anschluss auswählen. 
Die verfügbaren Auswahlmöglichkeiten sind 
von Ihrer Plattform und Konfiguration abhängig.

Machine Type

Nach Auswahl eines Anschlusses führt Pro Tools 
an diesem automatisch eine Auswertung 
durch, um festzustellen, welche Maschinenart 
angeschlossen ist. Wenn die Maschine erkannt 
wird, lädt Pro Tools den entsprechenden Machine 

Type. Dies umfasst das entsprechende Spuren-
Layout sowie die automatische Eingabe des 
Namens der Maschine im Machine Track Arming-
Fenster. Wenn die Maschine nicht erkannt wird, 
wird hingegen automatisch „Generic 1“ geladen. 

Preroll

Mit der Preroll-Einstellung können Sie einen 
variablen Wert für den Maschinenvorlauf 
entsprechend der Zeit festlegen, die die Maschine 
möglicherweise für ein Servo-Lock benötigt. 
Kürzere Vorlaufwerte sind in der Regel besser für 
nicht-lineare Maschinen. Längere Vorlaufwerte 
sind in der Regel besser für den Transport bei 
älteren Bandmedien. Der Maschinenvorlaufwert 
wird zu dem im Transport-Fenster angegebenen 
Vorlaufwert hinzugefügt.

9-Pin Remote (Deck Emulation)
(Nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme mit MachineControl)

Mit den 9-Pin Remote(Deck Emulation)-
Einstellungen können Sie Pro Tools für den 9-Pin 
Remote(Deck Emulation)-Modus konfigurieren. 
In diesem Modus arbeitet Pro Tools als virtuelle 
Bandmaschine, die die meisten Sony P2 9-Pin-
Standardbefehle unterstützt. Standardmäßig 
emuliert Pro Tools eine Videomaschine der 
Modellreihe Sony BVW-75. Sie können 
Pro Tools auch für die Emulation anderer 
Maschinen konfigurieren.

Aktivieren Sie

Wenn die Enable-Option aktiviert ist, befindet 
sich Pro Tools im 9-Pin Remote(Deck 
Emulation)-Modus.

Port

Mit der Port-Einstellung können Sie den 9-Pin 
MachineControl-Anschluss auswählen. 
Die verfügbaren Auswahlmöglichkeiten sind von 
Ihrer Plattform und Konfiguration abhängig.
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Machine Type

Über die Machine Type-Einstellung können Sie 
die Maschinenbeschreibung für bestimmte 
Maschinen-Controller (etwa Soundmaster 
ATOM) auswählen. Standardmäßig emuliert 
Pro Tools ein Sony BVW-75-Gerät. 

Chase LTC

Wenn die Chase LTC-Option aktiviert ist, reagiert 
Pro Tools weiterhin auf Befehle zur Spur-
Scharfschaltung und Aufnahme. Allerdings folgt 
Pro Tools eingehendem LTC, statt sich als Master- 
oder Slave-Gerät für den Maschinen-Controller zu 
verhalten. Wenn Sie Pro Tools zum Slave der 
LTC-Quelle machen, statt das Gerät zum Slave 
von Pro Tools-Timecode zu machen, können Sie 
Wartezeiten (und Bandabnutzung) vermeiden, 
die beim Positionieren und Ausrichten von Band 
am Cue-Punkt auftreten. 

MIDI Controllers
Auf der MIDI Controllers-Registerkarte können 
Sie bis zu vier verschiedene MIDI-Controller für 
Pro Tools konfigurieren.

Nummer und Farbe

Mit der Zeilennummer wird die Reihenfolge der 
ausgewählten Controller angezeigt. Die Farbe gibt 
Auskunft über den Controller-Fokus bei den Spur- 
und Plug-In-Steuerungen von Pro Tools.

Typ

Mit der Type-Einstellung können Sie den mit 
Ihrem Computer verbundenen MIDI-Controller 
auswählen. Wählen Sie aus den folgenden MIDI-
Controller-Typen:

• Command|8

• HUI

• Surround Panner

• M-Audio Keyboard

Receive From

Mit der Receive From-Einstellung können Sie den 
mit Ihrem MIDI-Controller verbundenen MIDI-
Eingang auswählen.
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Send To

Mit der Send To-Einstellung können Sie den 
mit Ihrem MIDI-Controller verbundenen MIDI-
Ausgang auswählen.

Anzahl der Kanäle

Mit der # Ch's-Einstellung (Anzahl der Kanäle) 
wird die Anzahl der vom ausgewählten MIDI-
Controller-Typ unterstützten 
Steuerungskanäle angezeigt.

Ethernet Controllers
Auf der Ethernet Controllers-Registerkarte können 
Sie bis zu sieben verschiedene Ethernet-Controller 
für Pro Tools konfigurieren.

Aktivieren Sie

Wenn diese Option ausgewählt ist, 
ist Pro Tools für die Steuerung durch einen oder 
mehrere Ethernet-Controller (etwa D-Command 
oder C|24) aktiviert.

Ethernet Port

Mit der Ethernet Port-Einstellung können 
Sie den Ethernet-Anschluss an Ihrem Computer 
auswählen, an dem Ihr Controller angeschlossen ist.

Nummer und Farbe

Mit der Zeilennummer wird die Reihenfolge der 
ausgewählten Controller angezeigt. Die Farbe 
entspricht der farblich markierten Fokusgrenze 
des Controllers bei den Spur- und Plug-In-
Steuerelementen von Pro Tools.

Ethernet Controller

Über das Ethernet Controller-Popup-Menü können 
Sie den Ethernet-Controller auswählen, den Sie 
verwenden möchten.

Name

Klicken Sie auf die Name-Schaltfläche, um einen 
Namen für den ausgewählten Ethernet-Controller 
einzugeben.

Enable EUCON (Extended User Control)

Wenn diese Option ausgewählt ist, ist Pro Tools 
für die Steuerung durch einen oder mehrere 
EUCON-kompatible Controller aktiviert. EUCON 
ist ein innovatives Hochgeschwindigkeits-
Ethernet-Protokoll, das von Avid entwickelt 
wurde, um eine direkte Kommunikation einer 
Hardware-Bedienoberfläche mit einer 
Softwareanwendung zu ermöglichen. 

Weitere Informationen zum Einsatz von 
Pro Tools mit EUCON finden Sie in der 
mit Ihrem Controller ausgelieferten 
Dokumentation.
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Mic Preamps
Auf der Mic Preamps-Registerkarte können Sie 
bis zu neun verschiedene Mikrofonvorverstärker 
(PRE) für Pro Tools konfigurieren.

Typ

Bei der Type-Einstellung stehen none und PRE zur 
Auswahl. Wählen Sie die PRE-Option aus, 
um angeschlossene Mikrofonvorverstärker 
auszuweisen.

Receive From

Mit der Receive From-Einstellung können Sie 
den MIDI-Eingang festlegen, an dem der 
Mikrofonvorverstärker angeschlossen ist.

Send To

Mit der Send To-Einstellung können Sie den 
MIDI-Ausgang festlegen, an dem der 
Mikrofonvorverstärker angeschlossen ist.

Defaults

Klicken Sie auf die Reset-Schaltfläche, um den 
entsprechenden Mikrofonvorverstärker auf seine 
Standardeinstellungen zurückzusetzen.

Retain Current Settings

Aktivieren Sie die Retain Current Settings-Option, 
um PRE-Kanaleinstellungen beizubehalten, wenn 
eine bestehende Session mit anderen Einstellungen 
geladen wird. Neue Sessions behalten automatisch 
die aktuellen Einstellungen bei.

Remote Lock-Out Mode

Wenn die Remote Lock-Out Mode-Option 
ausgewählt ist, ignorieren alle angeschlossenen 
PREs die Bedienelemente ihrer Vorderseite.

Satellites
Auf der Satellites-Registerkarte können Sie die 
Synchronisation zwischen mehreren Pro Tools-
Systemen (einschließlich ein Avid Video Satellite-
System) bei Nutzung von Satellite Link 
konfigurieren. 

Mit Satellite Link können Sie über ein Ethernet-
Netzwerk bis zu 12 Avid HDX- oder HD Native-
Systeme miteinander koppeln (oder eine beliebige 
Kombination von 11 Avid HDX- oder HD Native-
Systemen und einen Avid Video Satellite- bzw. 
einem Pro Tools Video Satellite-System) und so 
Positionen anfahren, Audiomaterial wiedergeben 
und den Transport anhalten sowie Wiedergabe-
Selektionen treffen und Spuren auf jedem der 
Systeme über jede beliebige angeschlossene 
Workstation soloschalten. 

Informationen zu Mikrofonvorverstärkern 
finden Sie im PRE-Handbuch.
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Mit Media Composer Video Satellite können Sie 
ein Avid HDX- oder HD Native-System und ein 
Media Composer-System zum Monitoring von 
Avid-Video miteinander verbinden. Mit Pro Tools 
Video Satellite können Sie ein Avid HDX- oder 
HD Native-System und ein hostbasiertes 
Pro Tools-System zum Monitoring von Avid- oder 
QuickTime-Video miteinander koppeln.

System Name

Geben Sie einen Namen für das lokale System ein. 
Dieser Name wird in der Liste verfügbarer 
Satelliten in anderen angeschlossenen Systemen 
mit Satellite Link-Option angezeigt.

Mode

Mit den Mode-Einstellungen können Sie das 
Satellitenverhalten im lokalen System konfigurieren. 

Administrator. – bei aktivierter Administrator-
Option wird das lokale System als 
Administratorsystem für sämtliche 
Satellitensysteme im Netzwerk eingerichtet. 
Satellitensysteme können vom 
Administratorsystem aus definiert werden. 

Satellite. – bei aktivierter Satellite-Option wird das 
lokale System als Satellitensystem im Netzwerk 
eingerichtet. Wenn sich ein System im Satellite-
Modus befindet, kann es von jedem Administrator-
system im Netzwerk aus als Satellitensystem 
definiert werden. 

Administrator

Wenn sich das lokale System im Administrator-
Modus befindet, können Sie über die Administrator-
Einstellungen Satelliten im System definieren. 

System 1–12. – in diesen Popup-Menüs können 
Sie über ein Administratorsystem bis zu 
11 Satellitensysteme (zusätzlich zum eigentlichen 
Administratorsystem) definieren. Die System-
nummer spiegelt die Reihenfolge der im 
Transport-Fenster definierten Satelliten wider.

Weitere Informationen finden Sie unter 
Kapitel 53: „Satellite Link“.
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VENUE
Auf der VENUE-Registerkarte können Sie Pro Tools 
für die Nutzung mit einem VENUE-System mit 
VENUE Link via Ethernet konfigurieren. 

Mit VENUE Link in Pro Tools können Sie 
VENUE-Einstellungen in Pro Tools importieren, 
Pro Tools-Marker aus VENUE-Snapshots 
erstellen sowie über VENUE-Snapshots 
Positionen von Pro Tools-Markern finden.

System Name

Im System Name-Feld können Sie einen Namen 
für Ihr Pro Tools-System eingeben.

VENUE System

Über den VENUE System-Selektor können Sie ein 
standortfernes VENUE-System für die Aufnahme 
auf (oder Wiedergabe von) Ihrem Pro Tools-
System auswählen. Die IP-Adressen des VENUE-
Systems können auch manuell eingegeben werden.

Advanced Network Settings

Unter den Advanced Network-Einstellungen 
können Sie eine IP-Adresse und einen Anschluss 
für die VENUE Link-Kommunikation angeben. 

Interface. – bei Systemen mit mehr als einer 
Ethernet-Netzwerkverbindung können Sie über 
die Interface-Einstellung auswählen, welche 
Verbindung für die VENUE Link-Kommunikation 
genutzt wird. 

TCP/UDP Port. – bei Systemen mit mehr als einer 
Ethernet-Netzwerkverbindung können Sie die 
TCP/UDP-Portnummer eingeben, die für die 
VENUE Link-Kommunikation genutzt werden soll.
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Kapitel 10: MIDI-Konfiguration

Wenn Sie in Verbindung mit Pro Tools externe 
MIDI-Geräte (wie etwa Controller oder 
Soundmodule) verwenden, können Sie Ihr MIDI-
Studio-Setup so anpassen, dass die Namen Ihrer 
MIDI-Geräte in Pro Tools angezeigt werden.

MIDI-Studio-Setup (Mac)
Pro Tools erkennt die Anschlüsse des MIDI-
Interface als generische Anschlüsse. Unter 
Mac OS X wird das Apple-Dienstprogramm 
Audio-MIDI-Setup (AMS) dazu verwendet, an das 
MIDI-Interface angeschlossene, externe MIDI-
Geräte zu identifizieren und das MIDI-Studio für 
die Verwendung mit Pro Tools zu konfigurieren.

So konfigurieren Sie Ihr MIDI-Studio mit AMS:

1 Sie haben folgende Möglichkeiten:

• Starten Sie Audio-MIDI-Setup (das Programm 
befindet sich in „Programme/Dienstprogramme“).

• Wählen Sie in Pro Tools Setup > 

MIDI > MIDI Studio.

2 Wenn das MIDI-Studio-Fenster nicht angezeigt 
wird, wählen Sie Fenster > MIDI-Studio. 

AMS durchsucht das System nach angeschlossenen 
MIDI-Interfaces. Wenn das MIDI-Interface 
ordnungsgemäß angeschlossen ist, wird es im 
Fenster zusammen mit den nummerierten Ports 
des Interface angezeigt.

3 Um ein benutzerdefiniertes MIDI-Gerät für 
ein externes MIDI-Gerät, das an Ihrem MIDI-
Interface angeschlossen ist, zu erstellen, klicken 
Sie auf Gerät hinzufügen. Es wird ein Symbol 
für ein neues externes Gerät zusammen 
mit dem Bild eines MIDI-Standard-
Keyboards angezeigt.

4 Ziehen Sie das Symbol für das neue Gerät an 
eine für Sie gut sichtbare Stelle im Fenster.

Um eine optimale Leistung zu erzielen, 
ändern Sie die AMS-Konfiguration nicht 
während einer Wiedergabe in Pro Tools. 
Halten Sie den Pro Tools-Transport an, 
bevor Sie AMS starten. 

Audio-MIDI-Setup (MIDI-Geräte-Registerkarte)
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5 Schließen Sie das MIDI-Gerät an das MIDI-
Interface an, indem Sie auf den Pfeil des 
entsprechenden Ausgangs am Gerät klicken 
und eine Verbindung (oder ein „Kabel“) zum 
Pfeil des entsprechenden Eingangs am MIDI-
Interface ziehen.

6 Klicken Sie auf den Pfeil des entsprechenden 
Eingangs am Gerät und ziehen Sie ein Kabel 
zum Pfeil des entsprechenden Ausgangs am 
MIDI-Interface. 

7 Wiederholen Sie die Schritte 3–6 für jedes 
MIDI-Gerät in Ihrer MIDI-Konfiguration.

So passen Sie ein externes MIDI-Gerät in AMS an:

1 Wählen Sie das Symbol für das externe Gerät 
aus und klicken Sie auf Info (oder doppelklicken 
Sie auf das Symbol für das neue Gerät). 

2 Wählen Sie den Hersteller und das Modell des 
neuen Geräts aus den entsprechenden Popup-
Menüs aus. (Wenn in den Popup-Menüs der 
Name Ihres Geräts nicht aufgeführt ist, können 
Sie auch einen Namen eingeben.)

Erstellen von MIDI-Ein- und Ausgängen

Um eine Verbindung zu entfernen, 
wählen Sie das „Kabel“ und klicken 
Sie auf „Entfernen“.

Symbol für externes Gerät

Benennen eines neuen MIDI-Geräts

 AMS sucht bei den Namen der 
Hersteller und Modelle im Verzeichnis 
„Root/Library/Audio/MIDI Devices“ nach 
Dateien mit der Erweiterung „.middev“. 
Pro Tools installiert eine Datei mit 
dieser Erweiterung, „Digidesign Device 
List.middev“, die Informationen zu 
zahlreichen im Handel erhältlichen MIDI-
Geräten enthält. Wenn für Ihr externes MIDI-
Gerät kein Hersteller- oder Modellname in 
den entsprechenden Popup-Menüs in AMS 
zur Auswahl steht, können Sie die Namen 
hinzufügen, indem Sie die aktuelle Datei 
mit der Erweiterung „middev“ in einem 
beliebigen Texteditor (etwa TextEdit) 
bearbeiten. 

Weitere Informationen finden Sie unter 
„MIDI-Patch-Namen“ auf Seite 717.
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3 Klicken Sie auf den Pfeil neben „Mehr 
Informationen“, um das Dialogfeld zu 
erweitern, und aktivieren Sie dann die 
entsprechenden MIDI-Kanäle (1–16) für die 
Senden- und Empfangen-Option. (Dadurch 
können Sie festlegen, welche Kanäle das Gerät 
zum Empfangen und Senden von MIDI-
Signalen verwendet.) 

4 Klicken Sie auf das Bild des Geräts. Im unteren 
Bereich des Fensters werden jetzt verschiedene 
MIDI-Geräte angezeigt (etwa Keyboards, 
Module, Interfaces und Mischpulte). Wählen 
Sie das Symbol für Ihr Gerät. 

5 Wählen Sie das Bild eines Geräts aus und 
klicken Sie auf Anwenden. 

6 Schließen Sie das AMS-Fenster, um AMS 
zu beenden. 

Die eingegebenen Gerätenamen werden bei den 
Auswahlmöglichkeiten für den MIDI-Eingang 
und -Ausgang in Pro Tools angezeigt.

Aktivieren von MIDI-Kanälen

Auswählen eines Gerätesymbols

Für die Verwendung von benutzerdefinierten 
Symbolen können Sie TIFF-Bilddateien 
im Verzeichnis „\Library\Audio\MIDI 
Devices\Generic\Images“ hinzufügen. 
Sie werden dann als Auswahlmöglichkeiten 
im Fenster für das AMS-Gerät angezeigt.
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MIDI-Studio-Setup (Windows)
Mit MIDI Studio Setup (MSS) können Sie die mit 
Ihrem System verbundenen MIDI-Controller und 
Soundmodule konfigurieren und das Routing der 
MIDI-Daten zwischen Ihren MIDI-Geräten und 
Pro Tools steuern.

MSS ermittelt automatisch die vorhandenen 
MIDI-Interfaces. Im MIDI Studio Setup-
Dokument können Sie für jeden MIDI-Anschluss 
einen benutzerdefinierten Namen angeben. 

MSS unterstützt XML-basierte Patch-Dateinamen 
zum Speichern und Importieren von Patch-Namen 
für Ihre externen MIDI-Geräte. 

In MSS erstellte MIDI-Studio-Setup-
Konfigurationen können vollständig importiert 
und exportiert werden. 

So konfigurieren Sie Ihr MIDI-Studio mit MSS:

1 Wählen Sie in Pro Tools Setup > 
MIDI > MIDI Studio.

2 Konfigurieren Sie die Einstellungen in den 
MIDI Studio Setup-Fenstern.

3 Wenn Sie die Konfiguration in MIDI Studio 
Setup abgeschlossen haben, schließen Sie das 
MIDI Studio Setup-Fenster.

MIDI Studio Setup-Fenster
Das MIDI Studio Setup-Fenster ist in drei 
Bereiche unterteilt: Die Steuerelemente für 
Interfaces befinden sich am oberen Rand des 
Fensters. Alle derzeit definierten Instrumente 
werden in der Name-Liste auf der linken Seite 
des Fensters angezeigt. Eine detaillierte Ansicht 
der MIDI-Parameter befindet sich auf der 
rechten Fensterseite.

Interface-Einstellungen

Erstellen – fügt der Name-Liste ein neues 
Instrument hinzu.

Delete – entfernt ein oder mehrere Instrumente aus 
der Name-Liste.

Importieren – importiert eine bestehende MIDI 
Studio Setup-Datei.

Export – exportiert die aktuelle MIDI Studio 
Setup-Datei.

Show Duplicate Emulated Ports – wenn diese 
Option aktiviert ist und Sie ein MIDI-Interface 
mit Unterstützung für Zeitstempel verwenden, 
werden im MIDI Studio Setup-Fenster sowohl 
die DirectMusic-Ausgangsanschlüsse mit 
Zeitstempel als auch die duplizierten, emulierten 
Ausgangsanschlüsse ohne Zeitstempel angezeigt. 

Instrument-Liste

Die Instrument-Liste enthält alle derzeit 
definierten Instrumente. Wenn Sie ein Instrument in 
der Liste auswählen, werden die dazugehörigen 
Eigenschaften im Properties-Bereich des 
Fensters angezeigt.

MIDI Studio Setup (Fenster)

Bei einigen MIDI-Interfaces werden die 
Treiber nur ordnungsgemäß geladen und 
deaktiviert, wenn Pro Tools beendet und neu 
gestartet wird. Weitere Informationen hierzu 
finden Sie in der mit Ihrem MIDI-Interface 
gelieferten Dokumentation.
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Properties-Bereich

Im Properties-Bereich können Sie die 
Eigenschaften neuer Instrumente oder eines 
derzeit in der Instrument-Liste ausgewählten 
Instruments bearbeiten.

Wenn Sie in der Instrument-Liste ein Instrument 
auswählen, dessen Eigenschaften bereits festgelegt 
wurden, werden diese im Properties-Bereich des 
ausgewählten Instruments angezeigt.

So definieren Sie ein Instrument in MIDI 
Studio Setup:

1 Wählen Sie Setup > MIDI > MIDI Studio.

2 Klicken Sie auf Create.

3 Geben Sie im Instrument Name-Feld den 
Namen des Instruments ein und drücken Sie 
die Eingabetaste.

4 Wählen Sie einen Hersteller und ein Modell für 
das neue Gerät in den entsprechenden Popup-
Menüs. Wenn in den Popup-Menüs der Name 
Ihres Geräts nicht aufgeführt ist, wählen 
Sie „None“.

5 Wählen Sie im Input-Popup-Menü den 
Eingang auf Ihrem MIDI-Interface aus, 
der an den MIDI-Ausgang des Instruments 
angeschlossen ist.

6 Wählen Sie im Popup-Menü „Output“ den 
Ausgang auf Ihrem MIDI-Interface aus, 
deran den MIDI Eingang des Instruments 
angeschlossen ist.

7 Aktivieren Sie unter „Send Channels“ und 
„Receive Channels“ die entsprechenden MIDI-
Kanäle (1–16). (Diese Optionen bestimmen, 
über welche Kanäle das MIDI-Material 
gesendet bzw. empfangen wird.)

Instrument Name

Im Instrument Name-Feld wird der 
benutzerdefinierbare Name des aktuell 
ausgewählten Instruments angezeigt.

Manufacturer

Das Manufacturer-Popup-Menü enthält eine 
Liste gängiger Hersteller von MIDI-Geräten. 
Diese Liste wird aus den XML-basierten MIDI-
Gerätedateien generiert. 

Modell

Das Model-Popup-Menü enthält eine nach 
Herstellernamen gefilterte Liste gängiger MIDI-
Geräte. Diese Liste wird aus den XML-basierten 
MIDI-Gerätedateien generiert, die mit Pro Tools 
mit installiert werden.

Input Port

Das Input Port-Popup-Menü zeigt eine Liste der 
verfügbaren Eingangsanschlüsse auf dem MIDI-
Interface an. Der hier festgelegte und angezeigte 
Anschluss des MIDI-Interface ist der Anschluss, 
durch den MIDI-Daten vom im Instrument Name-
Feld festgelegten externen MIDI-Gerät an das 
MIDI-Interface gesendet werden.

Wenn Sie keinen Instrumentennamen 
eingeben, übernimmt das Feld automatisch 
die Angaben aus den Popup-Menüs für den 
Hersteller und das Modell. 

Weitere Informationen finden Sie unter 
„MIDI-Patch-Namen“ auf Seite 717.

Weitere Informationen finden Sie unter 
„MIDI-Patch-Namen“ auf Seite 717.

Wenn Sie „None“ auswählen, ist das 
definierte Instrument nicht als Auswahl im 
MIDI Input-Selektor verfügbar. 
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Output Port

Das Output Port-Popup-Menü zeigt eine Liste der 
verfügbaren Ausgangsanschlüsse auf dem MIDI-
Interface an. Der hier festgelegte und angezeigte 
Anschluss ist der Anschluss, durch den MIDI-
Daten vom MIDI-Interface an das im Instrument 
Name-Feld festgelegte externe MIDI-Gerät 
gesendet werden.

Send Channels

Hier werden die Kanäle zum Senden von Daten für 
das im Instrument Name-Feld angegebene MIDI-
Gerät festgelegt. 

Receive Channels

Hier werden die Kanäle zum Empfangen von 
Daten für das im Instrument Name-Feld 
angegebene MIDI-Gerät festgelegt.

Wenn Sie „None“ auswählen, ist das 
definierte Instrument nicht als Auswahl im 
MIDI Output-Selektor verfügbar. 



Teil III:  Sessions und Spuren
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Kapitel 11: Sessions

Der erste Schritt zu Beginn eines neuen 
Pro Tools-Projekts ist das Erstellen einer neuen 
Session. Sessions werden durch Session-Dateien 
dargestellt, die gespeichert, kopiert und in 
Vorlagen umgewandelt werden können.

Quick Start-Dialogfeld 
für Sessions
Beim Start von Pro Tools wird ein Quick Start-
Dialogfeld angezeigt, mit dem Sie schnell und 
einfach eine neue Session erstellen oder eine 
vorhandene öffnen können. Unter „Operation 
Preferences“ in Pro Tools können Sie festlegen, 
ob das Quick Start-Dialogfeld beim Start ein-oder 
ausgeblendet werden soll.

Wenn Sie Pro Tools zum ersten Mal starten, haben 
Sie im Quick Start-Dialogfeld die folgenden 
Optionen:

• Erstellen einer neuen Session aus einer Vorlage.

• Erstellen einer neuen leeren Session.

• Öffnen einer der letzten zehn Sessions.

• Öffnen einer anderen Session in Ihrem System.

Erstellen einer neuen Session 
aus einer Vorlage

So erstellen Sie eine neue Session aus 
einer Vorlage:

1 Wählen Sie die Create Session from 

Template-Option.

2 Wählen Sie im Session Template-Popup-Menü 
die Kategorie für die gewünschten Session-
Vorlagen aus.

Drücken Sie Strg + Nach oben/Nach unten 
(Windows) bzw. Befehl + Nach oben/Nach 
unten (Mac), um verschiedene Quick 
Start-Optionen für Sessions auszuwählen. 
Sie können auch die Nach-oben- und Nach-
unten-Pfeiltasten verwenden, um in den 
Listen „Recent Sessions“ und „Session 
Templates“ verschiedene Elemente 
auszuwählen.

Session Template-Popup-Menü, Quick Start-Dialogfeld

Sie können eigene benutzerdefinierte 
Kategorien erstellen. Weitere Informationen 
dazu finden Sie unter „Session-Vorlagen“ 
auf Seite 169. 
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3 Wählen Sie die gewünschte Session-Vorlage 
aus der Liste (rechts) aus.

4 Wenn Sie Session-Parameter ändern möchten, 
klicken Sie auf die Session Parameters-
Anzeigeschaltfläche (um die Parameter 
anzuzeigen) und führen Sie einen der folgenden 
Schritte aus:

• Wählen Sie unter Audio File Type den 
Audiodateityp für die Session.

• Wählen Sie unter Bit Depth die Bitrate aus 
(16 Bit, 24 Bit, oder 32-Bit-Gleitkomma).

• Wählen Sie Interleaved aus, um Mehrkanal-
Interleaved-Audiodateien in der Session 
zu erstellen.

• Wählen Sie unter Sample Rate eine Samplerate.

5 Klicken Sie auf OK.

6 Geben Sie im Save-Dialogfeld einen Namen für 
die Session ein, geben Sie an, wo die Session 
gespeichert werden soll, und klicken Sie auf 
Save.

Erstellen einer neuen 
leeren Session
So erstellen Sie eine neue leere Session:

1 Wählen Sie die Create Blank Session-Option.

2 Wenn Sie Session-Parameter ändern möchten, 
klicken Sie auf die Session Parameters-
Anzeigeschaltfläche und führen Sie einen 
der folgenden Schritte aus:

• Wählen Sie unter Audio File Type den 
Audiodateityp für die Session.

• Wählen Sie unter Bit Depth die Bitrate aus 
(16 Bit, 24 Bit, oder 32-Bit-Gleitkomma).

• Wählen Sie Interleaved aus, um Mehrkanal-
Interleaved-Audiodateien in der Session 
zu erstellen.

• Wählen Sie unter Sample Rate eine Samplerate.

• Wählen Sie die I/O-Einstellungen für diese 
Session. Im Lieferumfang des Systems sind 
mehrere vorkonfigurierte I/O-Einstellungen 
enthalten. Sie können aber auch eine 
benutzerdefinierte I/O-Einstellung verwenden. 
Weitere Informationen finden Sie unter 
Kapitel 7: „I/O-Setup.“ 

Quick Start-Dialogfeld mit angezeigten 
Session-Parametern

Stellen Sie als Dateityp „BWF (.WAV)“ 
ein, um optimale Kompatibilität zwischen 
Windows und Mac zu erzielen. 

Quick Start-Dialogfeld mit der Create Blank 
Session-Option
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3 Klicken Sie auf OK.

4 Geben Sie im Save-Dialogfeld einen Namen für 
die Session ein, geben Sie an, wo die Session 
gespeichert werden soll, und klicken Sie auf 
Save.

Öffnen einer zuletzt 
verwendeten Session

So öffnen Sie eine zuletzt verwendete Session:

1 Wählen Sie die Open Recent Session-Option.

2 Wählen Sie eine der letzten zehn Sessions aus 
der Liste (rechts) aus.

3 Klicken Sie auf OK.

Öffnen einer beliebigen Session

So öffnen Sie eine beliebige Session:

1 Wählen Sie die Open Session-Option.

2 Klicken Sie auf OK.

3 Navigieren Sie im Choose a Session-Dialogfeld 
zum Speicherort der Session-Datei und wählen 
Sie sie aus.

4 Klicken Sie auf Open.

Ein-oder Ausblenden des Quick 
Start-Dialogfelds beim Start

So legen Sie fest, dass das Quick Start-Dialogfeld 
beim Starten von Pro Tools nicht angezeigt wird:

 Deaktivieren Sie die Option Show Quick Start 

Dialog when Pro Tools Starts im Quick Start-
Dialogfeld oder unter „Operation Preferences“ 
in Pro Tools (Setup > Preferences).

So legen Sie fest, dass das Quick Start-Dialogfeld 
beim Starten von Pro Tools angezeigt wird:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Display-Registerkarte.

3 Wählen Sie im Warnings & Dialogs-Bereich 
der Display Preferences-Registerkarte die 
Option Show Quick Start Dialog when 

Pro Tools Starts.

4 Klicken Sie auf OK.

Beim ersten Start von Pro Tools ist die Open 
Recent Session-Option nicht verfügbar (oder 
wenn Sie die Recent Sessions-Liste über 
„File > Open Recent > Clear“ gelöscht 
haben).

Quick Start-Dialogfeld mit der Open Recent 
Session-Option

Option „Show Quick Start Dialog when Pro Tools Starts“
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Erstellen einer neuen Session
Im New Session-Dialogfeld können Sie eine neue 
Session aus einer Vorlage oder eine neue leere 
Session (ohne Spuren oder Medien) erstellen.

Erstellen einer neuen 
Session aus einer Vorlage

So erstellen Sie eine neue Session aus einer Vorlage:

1 Wählen Sie File > New.

2 Wählen Sie im New Session-Dialogfeld die 
Create Session from Template-Option.

3 Wählen Sie im Session Template-Popup-Menü 
die Kategorie für die gewünschten 
Session-Vorlagen aus.

4 Wählen Sie die gewünschte Session-Vorlage aus.

5 Wählen Sie unter Audio File Type den 
Audiodateityp für die Session.

6 Wählen Sie unter Bit Depth die Bitrate aus 
(16 Bit, 24 Bit, oder 32-Bit-Gleitkomma).

7 Wählen Sie Interleaved aus, um Mehrkanal-
Interleaved-Audiodateien in der Session 
zu erstellen.

8 Wählen Sie unter Sample Rate eine Samplerate.

9 Klicken Sie auf OK.

10 Geben Sie im Save-Dialogfeld einen Namen für 
die Session ein, navigieren Sie zu dem 
Speicherort, an dem die neue Session 
gespeichert werden soll, und klicken Sie 
auf Save.

Erstellen einer neuen 
leeren Session

So erstellen Sie eine neue leere Session:

1 Wählen Sie File > New.

2 Wählen Sie im New Session-Dialogfeld die 
Create Blank Session-Option.

3 Wählen Sie unter Audio File Type den 
Audiodateityp für die Session.

4 Wählen Sie unter Bit Depth die Bitrate aus 
(16 Bit, 24 Bit, oder 32-Bit-Gleitkomma).

5 Wählen Sie Interleaved aus, um Mehrkanal-
Interleaved-Audiodateien in der Session 
zu erstellen.

6 Wählen Sie unter Sample Rate eine Samplerate.

New Session-Dialogfeld mit der Create Session from 
Template-Option

Stellen Sie als Dateityp „BWF (.WAV)“ ein, 
um optimale Kompatibilität zu erzielen. 

New Session-Dialogfeld mit der Create Blank 
Session-Option
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7 Wählen Sie die I/O-Einstellungen für diese 
Session. Im Lieferumfang des Systems sind 
mehrere vorkonfigurierte I/O-Einstellungen 
enthalten. Sie können aber auch eine 
benutzerdefinierte I/O-Einstellung verwenden. 
Weitere Informationen finden Sie unter 
Kapitel 7: „I/O-Setup.“

8 Klicken Sie auf OK.

9 Geben Sie im Save-Dialogfeld einen Namen für 
die Session ein, navigieren Sie zu dem 
Speicherort, an dem die neue Session 
gespeichert werden soll, und klicken Sie 
auf Save.

Bitrates und Samplerates
Bei der Wahl der Bitrate oder Samplerate für die 
Session müssen Sie die Klangtreue, die 
Kompatibilität mit anderen Systemen und die 
Speicherkapazität berücksichtigen. 

Die Bitrate und die Samplerate wirken sich auch 
auf die in einer Session verfügbare Mischleistung 
aus. Bei Sessions mit Samplerates von 24 Bit und 
32-Bit-Gleitkomma oder höher stehen weniger 
Mischkanäle zur Verfügung.

Bitraten
16-Bit. – verwenden Sie 16 Bit für Audiodateien, 
wenn Sie die Größe der Audiodateien möglichst 
gering halten möchten. Die Verwendung von 16 Bit 
wird besonders für Sessions mit wenig Spuren 
und Mixing sowie geringer Plug-In-Verarbeitung 
empfohlen. CDs (Compact Discs) verwenden 
16 Bit.

24-Bit. – 24-Bit-Audiodateien werden in der Regel 
bei den meisten Musikproduktionen und 
Postproduktions-Sessions mit mehreren 
Audiospuren sowie viel Mixing und hoher 
Plug-In-Verarbeitung verwendet. 24-Bit-Dateien 
nehmen ein Drittel mehr Plattenspeicher in 
Anspruch als 16-Bit-Dateien.

32-Bit-Gleitkomma. – durch die 
32-Bit-Gleitkomma-Bitrate bei Audiodateien 
in Pro Tools-Sessions kann die Übersteuerung und 
unnötiges Dithering beim AudioSuite-Rendering 

vermieden werden. Weiterhin können 
Rundungsfehler bei der Signalverarbeitung (die 
während der Bitratekonvertierung für die 
Dateiwiedergabe und bei der Echtzeitverarbeitung 
von Plug-In-Inserts entstehen können) vermieden 
werden. 32-Bit-Dateien nehmen jedoch ein Drittel 
mehr Festplattenspeicher und Audio-Streaming-
Bandbreite in Anspruch, was problematisch 
werden kann, wenn Sie auf langsameren 
Festplatten mehr Spuren verwenden.

Sie können die Bitrate für alle neu aufgenommenen 
oder importierten (und konvertierten) Dateien in der 
Session ändern, indem Sie im Session-Setup-Fenster 
eine andere Bit Depth-Option auswählen.

So ändern Sie die Bitrate der Pro Tools-Session:

1 Wählen Sie Setup > Session.

2 Wählen Sie im Session-Setup-Fenster über den 
Bit Depth-Selektor die gewünschte Bitrate aus. 

Samplerates
44,1 kHz. – ist die Samplerate, die für CDs 
und üblicherweise in den meisten 
Musikproduktionen verwendet wird.

48 kHz. – ist die Standard-Samplerate in Film- und 
Videoprojekten und wird üblicherweise in 
Postproduktions-Umgebungen verwendet. Es ist 
die Samplerate, die für DVDs verwendet wird.

Session-Setup-Fenster, 32-Bit-Gleitkomma
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88,2 kHz und 96 kHz. – bei CDs und DVDs sind 
diese Samplerates jeweils doppelt so hoch wie die 
Standard-Samplerates. Audiodateien, die mit 
höheren Samplerates aufgenommen werden, 
nehmen mehr Festplattenspeicher in Anspruch, 
ermöglichen dafür aber eine höhere Auflösung bei 
zeitbasierter Plug-In-Verarbeitung (wodurch 
Aliasing-Effekte vermieden werden können). 
Diese Optionen sind nur dann verfügbar, wenn Sie 
Pro Tools mit Audio-Hardware ausführen, 
die diese Samplerates unterstützt.

176,4 kHz bis 192 kHz. – bei CDs und DVDs sind 
diese Samplerates jeweils viermal so hoch wie die 
Standard-Samplerates. Audiodateien, die mit 
höheren Samplerates aufgenommen werden, 
nehmen mehr Festplattenspeicher in Anspruch, 
ermöglichen dafür aber eine höhere Auflösung bei 
zeitbasierter Plug-In-Verarbeitung (wodurch 
Aliasing-Effekte vermieden werden können). 
Diese Optionen sind nur dann verfügbar, wenn Sie 
Pro Tools mit Audio-Hardware ausführen, 
die diese Samplerates unterstützt.

Gemischte Audiodateiformate
Pro Tools unterstützt das Mischen von 
Audiodateiformaten (wie WAV und AIF) in einer 
einzelnen Session. Beim Importieren von 
Audiodateien in eine Pro Tools-Session haben Sie 
die Wahl aus zwei Möglichkeiten: Hinzufügen 
oder Konvertieren unabhängig vom ursprünglichen 
Audiodateiformat.

Sie können das Audiodateiformat für alle neu 
aufgenommenen oder importierten (und 
konvertierten) Dateien in einer Session ändern, 
indem Sie eine andere Audio Format-Option 
im Session-Setup-Fenster auswählen.

So ändern Sie das Audioformat der 
Pro Tools-Session:

1 Wählen Sie Setup > Session.

2 Wählen Sie im Session-Setup-Fenster über den 
Audio Format-Selektor das gewünschte 
Audiodateiformat (AIF oder WAV) aus. 

Mehrkanal-Interleaved und 
Multimono-Audiodateien
Pro Tools unterstützt sowohl Mehrkanal-
Interleaved- als auch Multimono-Audiodateien für 
Stereo- und Mehrkanal-Audio.

Eine Interleaved-Audiodatei enthält alle in einem 
einzelnen, alternierenden Audio-Stream 
gespeicherten Kanalinformationen. „Interleaving“ 
bedeutet, dass die aufeinander folgenden Daten 
verteilt und „überlappt“ werden. Dies kann 
verhindern, dass beim Rücklesen der Daten 
weitere Fehler entstehen.

Multimono- oder „Split-Mono“-Mehrkanal-
Audiodateien sind separate Mono-Audiodateien, die 
in Gruppen von Mehrkanal-Audiodateien 
zusammengefasst werden. Auf diese Weise können 
Sie jeden Kanal (jede Datei) individuell bearbeiten. 
Bei Stereodateien werden beispielsweise zwei 
separate Dateien erstellt, jeweils eine für den linken 
bzw. rechten Kanal. Die Dateien sind anhand der 
Suffixe „L“ und „R“ erkennbar. Die beiden Dateien 
sind gekoppelt und werden als Stereospur in 
Pro Tools bearbeitet. Sie haben jedoch die 
Möglichkeit, die Dateien zu entkoppeln und in 
separate Mono-Audiospuren zu teilen, um sie so 
unabhängig voneinander editieren, bearbeiten und 
mischen zu können. 

Sie können die Interleaved-Einstellung der aktuell 
geöffneten Session im Session-Setup-Fenster ändern. 
Wenn diese Option aktiviert ist, werden alle 
aufgenommenen oder importierten (und 
konvertierten) Stereo- oder Mehrkanaldateien in der 
Session zu Interleaved-Audiodateien.

So (de)aktivieren Sie Interleaved-Audiodateien 
in der Pro Tools-Session:

1 Wählen Sie Setup > Session.

2 (De)aktivieren Sie im Session-Setup-Fenster 
die Interleaved-Option.
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Session-Dateien und -Ordner
Beim Erstellen einer neuen Session erstellt Pro Tools 
automatisch einen neuen Ordner mit dem Namen der 
Session. In diesem Ordner befinden sich die Session-
Datei, eine WaveCache-Datei (.wfm) und mehrere 
Unterordner (unter anderem für Audiodateien und 
Clipgruppen).

Session-Dateien
Die Session-Datei ist das Dokument, das Pro Tools 
beim Start eines neuen Projekts erstellt. In Pro Tools 
kann nur eine Session gleichzeitig geöffnet sein. Dem 
Namen der Session-Datei wird automatisch die 
Erweiterung .ptx angehängt.

Audio Files-Ordner
Der Audio Files-Ordner enthält alle während 
der Session aufgenommenen oder 
konvertierten Audiodateien. 

Wenn Sie eine neue Audiospur aufnehmen, wird 
diese als neue Audiodatei im Audio Files-Ordner 
abgelegt. Sie können auch andere Audiodateien in 
die Session importieren und damit arbeiten. 

Fade Files-Ordner
Der Fade Files-Ordner ist möglicherweise auch in 
älteren Pro Tools-Sessions vorhanden. Ältere 
Versionen als Pro Tools 10.0 verwenden gerenderte 
Fades und Crossfades, die in den Fade Files-Ordner 
im Session-Folder geschrieben werden.

Rendered Files-Ordner
Der Rendered Files-Ordner enthält alle temporären 
Dateien, die von der gerenderten Elastic Audio-
Verarbeitung in der Session erstellt wurden. 
Darüber hinaus können auch temporäre gefilterte 
Analysedateien (.aan) als Ergebnis von 
Änderungen an der Elastic Audio-Analyse 
enthalten sein.

Clip Groups-Ordner
Der Clip Groups-Ordner ist das 
Standardverzeichnis für alle Clipgruppen, die Sie 
aus der Pro Tools-Session exportieren.

WaveCache-Datei
In der Datei „WaveCache.wfm“ werden alle Daten 
für die Wellenformdarstellung in der Session 
abgelegt. Wenn Sie diese WaveCache.wfm-Datei 
löschen, erstellt Pro Tools eine neue, wenn die 
Session das nächste Mal geöffnet wird.

Typischer Inhalt eines Session-Ordners (hier Mac OS X)

Ausführliche Informationen zum Zuweisen von 
Audiospuren für Speicherorte auf 
unterschiedlichen Festplattenlaufwerken, 
einschließlich gemeinsam genutzter Medien-
Volumes, finden Sie unter „Aufnehmen mit 
mehreren Festplatten“ auf Seite 445.
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Durch Speichern der Wellenformdaten in der 
WaveCache-Datei können Sessions schneller 
geöffnet werden. Die WaveCache-Datei kann 
beim Übertragen der dazugehörigen Session auf 
andere Pro Tools-Systeme (7.x und höher) mit 
aufgenommen werden. 

Darüber hinaus legt Pro Tools eine gesonderte 
WaveCache-Datei im Databases-Ordner ab. Diese 
Datei enthält Wellenformdaten für sämtliche 
im System verwendeten Dateien.

Wenn Sie eine WaveCache-Datei löschen oder in 
den Papierkorb verschieben, hat dies keine 
negativen Auswirkungen auf die Session oder das 
System. Es kann jedoch länger dauern, bis sich die 
Session öffnet, da die Wellenformdaten für alle 
zugehörigen Audiodateien erneut berechnet und 
diese Daten in einer neuen WaveCache-Datei 
gespeichert werden müssen. 

Session File Backups-Ordner
Der Session File Backups-Ordner enthält 
automatisch generierte Sicherungskopien der 
Pro Tools-Sessions. Diese Dateien werden während 
der Arbeit an der Session erstellt, vorausgesetzt, die 
Operations-Voreinstellung für Enable Session File 

Auto Backup ist aktiviert. (Siehe „Enable Session File 
Auto Backup“ auf Seite 110.)

Renamed Audio Files-Ordner
Dieser Ordner enthält die Namen von Dateien, 
die beim Öffnen der Session umbenannt wurden, 
wenn die ursprünglichen Namen der Audiodateien 
unzulässige Zeichen enthielten. In manchen Fällen 
wird stattdessen in Versionen von Pro Tools, die 
keine langen Dateinamen unterstützen, eine Kopie 
der Session gespeichert.

Öffnen einer Session
Wenn Sie eine Session öffnen, sucht Pro Tools 
im Session-Ordner nach damit verknüpften 
Audio- und Fade-Dateien.

So öffnen Sie eine bestehende Session:

1 Wählen Sie File > Open Session.

2 Suchen Sie die gewünschte Session und klicken 
Sie auf Open.

Öffnen einer Session mit Fade-
Dateien
Beim Öffnen von Sessions, die in niedrigeren 
Versionen als Pro Tools 10.0 erstellt wurden, 
berechnet Pro Tools alle Fades in Echtzeit und gibt 
sie in Echtzeit wieder. Der „Fade Files“-Ordner im 
Session-Folder wird weder benutzt noch gelöscht. 
Gerenderte Fades aus Legacy-Sessions werden 
in Echtzeit berechnet und wiedergegeben. Bei neuen, 
in der Session erstellten Fades wird im bereits 
vorhandenen „Fade Files“-Ordner keine 
Render-Faderdatei erstellt.

Weitere Informationen dazu finden Sie unter 
„Renamed Audio Files“ auf Seite 387.

Weitere Information zum Öffnen von Sessions, 
die auf verschiedenen Plattformen, Pro Tools-
Systemen oder in verschiedenen Versionen der 
Pro Tools-Software erstellt wurden, finden Sie 
unter Kapitel 18: „Datei-/Sessionverwaltung 
und -kompatibilität.“

Außerdem können Sie eine Session in einem 
Workspace-Browser öffnen, indem Sie darauf 
doppelklicken.

SD II-Dateien, die für den Import in 
Pro Tools vorgesehen sind, müssen in ein 
unterstütztes Audiodateiformat konvertiert 
werden (WAV oder AIF).
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Öffnen einer Session mit nicht 
verfügbaren Dateien
Wenn Dateien zwar gefunden werden, aber auf 
Transfer-Volumes gespeichert sind, gibt Pro Tools 
eine Meldung aus. Weitere Informationen dazu 
finden Sie unter „Suchen von Audiodateien“ auf 
Seite 386.

Öffnen einer Session von einem 
Transfer-Volume aus
Wenn Sie eine Session von einem Transfer-
Volume (etwa einer CD oder DVD) aus öffnen, 
fordert Pro Tools Sie auf, die Session auf einem 
Performance-Volume zu speichern und eventuell 
vorhandene referenzierte Mediendateien zu 
kopieren und zu konvertieren. Weitere 
Informationen dazu finden Sie unter „Suchen von 
Audiodateien“ auf Seite 386.

Öffnen einer Session mit nicht 
verfügbaren Elementen
Beim Öffnen einer Session mit nicht verfügbaren 
Voices, I/O-Pfaden, DSP-Ressourcen oder Plug-
Ins zeigt Pro Tools eine entsprechende 
Warnmeldung an. Dies passiert häufig beim 
Übertragen von Sessions zwischen Systemen mit 
unterschiedlicher Pro Tools-Hardware.

Im Unavailable Resources-Dialogfeld wird ein 
vorläufiger Bericht zu den fehlenden Session-
Komponenten angezeigt. Um eine Textdatei (.txt) 
mit einem detaillierteren Notes-Bericht sowie der 
darauf folgenden Aktion zu speichern, klicken Sie 
auf Yes. Der Name des Notes-Berichts enthält den 
Session-Namen, gefolgt von „Notes.txt“. Diese Datei 
kann im Session-Ordner oder an einem anderen 
Speicherort gespeichert werden.

Beim Öffnen einer Session mit nicht verfügbaren 
Elementen geschieht Folgendes:

Alle Pro Tools-Systeme:

 Nicht verfügbaren Plug-Ins zugewiesene 
Inserts werden deaktiviert.

 Nicht verfügbaren Pfaden zugewiesene 
Ausgänge, Eingänge und Sends werden 
deaktiviert.

Nur Pro Tools|HDX-Systeme:

 Alle Spuren, die über die auf dem aktuellen 
System verfügbare Höchstanzahl von Voices 
hinausgehen, werden deaktiviert. 

Nur hostbasierte Pro Tools-Systeme:

 Alle Spuren, die über die auf dem aktuellen 
System verfügbare Höchstanzahl von Voices 
hinausgehen, werden auf Voice Off gesetzt.

Öffnen einer Session, die 
Audiodateinamen mit 
ungültigen Zeichen enthält
Pro Tools unterstützt keine Audiodateinamen, die 
folgende ASCII-Zeichen enthalten:

/ (Schrägstrich)

\ (umgekehrter Schrägstrich)

: (Doppelpunkt)

* (Sternchen)

? (Fragezeichen)

“ (Anführungszeichen)

< (Kleiner-als-Zeichen)

> (Größer-als-Zeichen)

| (senkrechter Strich, Verkettungszeichen)

Komplexe (durch Tastenkombination erstellte) 
ASCII-Zeichen
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Beim Öffnen von Sessions, die Audiodateien mit 
unzulässigen Zeichen enthalten, erstellt Pro Tools 
automatisch Kopien der betreffenden Dateien unter 
neuen Namen. Die unzulässigen Zeichen werden 
dabei durch Unterstriche („_“) ersetzt. Die 
umbenannten Dateien werden in den Renamed 
Audio Files-Ordner kopiert. Die ursprünglichen 
Dateien bleiben im Audio Files-Ordner erhalten.

Bevor die Session geöffnet wird, werden Sie 
aufgefordert, einen ausführlichen Bericht über die 
umbenannten Dateien und die ursprünglichen 
Dateinamen in einer Notes-Textdatei zu speichern. 
Folgen Sie den Anweisungen auf dem Bildschirm. 
Standardmäßig wird die Notes-Textdatei 
im Session-Ordner gespeichert.

Öffnen einer Session, die mit 
+6 dB Fader-Verstärkung 
gespeichert wurde
Die Fader-Verstärkung bei Sessions in Pro Tools 
7.x und höher beträgt immer +12 dB. Wenn Sie 
jedoch eine Session aus Pro Tools 7.x oder höher 
in einer älteren Version von Pro Tools speichern, 
die sowohl +6 dB als auch +12 dB als Fader-
Verstärkung unterstützt, können Sie für die neue 
Session entweder +6 dB oder +12 dB als 
maximale Fader-Verstärkung wählen.

Beim Speichern einer +12-dB-Session als eine 
+6-dB-Session gibt Pro Tools eine Warnmeldung 
aus mit dem Hinweis, dass eventuell vorhandene 
Automationseinstellungen über +6 dB auf +6 dB 
reduziert werden. Siehe „Speichern einer Kopie 
der Session“ auf Seite 164.

Wenn Sie eine Session, die mit einer maximalen 
Verstärkung von +6 dB gespeichert wurde, 
in Pro Tools 7.x oder höher öffnen, wird sie 
aktualisiert und die Verstärkung wird in 
+12 dB geändert.

Öffnen zuletzt 
verwendeter Sessions
Mit dem Open Recent-Untermenü im File-Menü 
können Sie eine der 10 zuletzt in Pro Tools 
aufgerufenen Sessions öffnen.

So öffnen Sie eine zuletzt verwendete Session:

 Wählen Sie File > Open Recent und 
anschließend die zu öffnende Session.

Wenn eine Session bei der Auswahl einer zuletzt 
geöffneten Session geöffnet ist, werden Sie 
aufgefordert, diese zu speichern, bevor sie von 
Pro Tools geschlossen und die ausgewählte zuletzt 
geöffnete Session geöffnet wird.

So öffnen Sie die zuletzt geöffnete Session:

 Drücken Sie Strg + Umschalt + O (Windows) 
bzw. Befehl + Umschalt + O (Mac).

So löschen Sie das Untermenü für zuletzt 
geöffnete Sessions:

 Wählen Sie File > Open Recent und 
anschließend Clear.

Öffnen von Sessions mit 
deaktivierten Plug-Ins
In Pro Tools können Sie Sessions öffnen, in denen 
die Plug-Ins deaktiviert sind. Da das Laden von 
Sessions mit vielen Plug-Ins lange dauern kann, 
können Sie auf diese Weise eine Session schnell 
öffnen, um sie visuell zu prüfen und wiederzugeben 
(ohne Plug-Ins). Ist es die Session, mit der Sie 
arbeiten möchten, können Sie sie problemlos mit 
aktivierten Plug-Ins erneut öffnen.

So öffnen Sie eine Pro Tools-Session 
mit deaktivierten Plug-Ins:

1 Wählen Sie in Pro Tools File > Open Session.

2 Suchen Sie im Open Session-Dialogfeld die 
gewünschte Session und wählen Sie sie aus.

3 Klicken Sie bei gedrückter Umschalttaste 
auf Open.
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Um dieselbe Session mit aktivierten Plug-Ins 
wieder zu öffnen, führen Sie einen der folgenden 
Schritte aus:

 Wählen Sie File > Revert To Saved.

 Wählen Sie File > Open Recent und wählen Sie 
im Untermenü die letzte Session aus.

Speichern einer Session
Sie sollten Ihre Sessions während der Arbeit 
regelmäßig speichern, um sicherzustellen, dass 
Ihre Änderungen auf der Festplatte nicht verloren 
gehen.

Speichern der Session-Datei
Mit dem Save-Befehl wird die Session mit den 
daran vorgenommenen Änderungen gespeichert 
und die Vorversion der Session-Datei 
überschrieben. Der Save-Befehl lässt sich nicht 
rückgängig machen.

So speichern Sie eine Session:

 Wählen Sie File > Save.

Zurücksetzen auf eine zuvor 
gespeicherte Session-Datei
Wenn Sie seit dem letzten Speichern Änderungen an 
Ihrer Session vorgenommen haben, können Sie diese 
verwerfen und die Session in den Zustand der zuvor 
gespeicherten Version zurücksetzen.

So setzen Sie eine Session auf die zuletzt 
gespeicherte Version zurück:

 Wählen Sie File > Revert to Saved.

Speichern der Session-Datei 
unter einem neuen Namen
Mithilfe des Save As-Befehls können Sie eine Kopie 
der aktuellen Session unter einem neuen Namen bzw. 
in einem anderen Verzeichnis auf der Festplatte 
speichern. Der Save As-Befehl schließt die aktuelle 
Session und Sie können an der umbenannten Kopie 
weiterarbeiten. Das ist hilfreich, wenn Sie gerade 
experimentieren und einen Versionsverlauf Ihrer 
Session erstellen möchten.

Auf diese Weise können Sie Ihre Arbeit schnell 
und einfach Schritt für Schritt rekonstruieren und 
zu einer früheren Version Ihrer Session 
zurückkehren. Mit dem Save As-Befehl speichern 
Sie nur eine neue Version der Session-Datei; 
Audio- oder Fade-Dateien werden nicht doppelt 
gespeichert.

Drücken Sie Strg + Umschalt + O 
(Windows) oder Befehl + Umschalt + O 
(Mac), um die letzte Session zu öffnen.

Damit Sie nicht die gespeicherte Version der 
Session aufrufen müssen, um die Session mit 
allen aktivierten Plug-Ins zu öffnen, können Sie 
ein einzelnes Plug-In einfach aktivieren, indem 
Sie bei gedrückter Windows- und Strg-Taste 
(Windows) oder Befehls- und Ctrl-Taste (Mac) 
darauf klicken. Um eine gesamte Reihe von 
Plug-Ins zu aktivieren, klicken Sie bei 
gedrückter Strg-, Alt- und Windows-Taste 
(Windows) bzw. Befehls-, Wahl- und Ctrl-Taste 
(Mac) auf ein beliebiges Plug-In in der Reihe 
der Inserts.

Wenn Sie die Operation-Voreinstellung für 
„Auto Backup“ aktiviert haben, können Sie auch 
eine Sicherungskopie der Session öffnen. Mit 
dieser Funktion können Sie festlegen, wie viele 
Sicherungskopien erhalten bleiben sollen und 
wie oft die Session gespeichert werden soll. Siehe 
„Auto Backup-Abschnitt“ auf Seite 110.

Sie können eine Session auf eine zuvor 
gespeicherte Session-Datei zurücksetzen, 
wenn beim Öffnen einer Session alle Plug-Ins 
deaktiviert waren und Sie die Plug-Ins durch 
erneutes Öffnen aktivieren möchten. Siehe 
„Öffnen von Sessions mit deaktivierten 
Plug-Ins“ auf Seite 162.
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So speichern Sie eine Session unter einem 
neuen Namen:

1 Wählen Sie File > Save As. 

2 Geben Sie den neuen Namen der Session ein.

3 Klicken Sie auf Save.

Die umbenannte Session-Datei wird zusammen mit 
der Original-Session im Session-Ordner gespeichert, 
es sei denn, Sie geben einen anderen Speicherort an. 
Alle neuen Audiodateien, die Sie in Ihrer 
umbenannten Session aufnehmen, werden in dem 
Audio Files-Ordner abgelegt, der für Ihre Original-
Session angelegt wurde. 

Speichern einer Kopie 
der Session
Mithilfe des Save Copy In-Befehls können Sie 
eine Kopie der aktuellen Session ein- oder 
ausschließlich der dazugehörigen Audio- und 
Fade-Dateien speichern. Außerdem können Sie 
Session-Format, Audiodateiformat, Bitrate und 
Samplerate für diese Kopie definieren.

So speichern Sie die Kopie einer Session an einem 
neuen Speicherort:

1 Wählen Sie File > Save Copy In.

2 Wählen Sie im Save Session Copy-Dialogfeld 
ein Zielverzeichnis für die neue Session-Datei 
aus und geben Sie einen Namen für sie ein.

3 Wählen Sie ein Session-Dateiformat (Save As 

Type) für die kopierte Session.

4 Legen Sie unter Audio File Type den 
Audiodateityp für die kopierte Session fest. 
Wenn die Audiodateien mit Windows- und 
Mac-Systemen kompatibel sein sollen, wählen 
Sie als Einstellung „BWF (.WAV)“ oder 
„AIFF“.

5 Legen Sie unter Sample Rate die Samplerate 
und unter Bit Depth die Bitrate für die kopierte 
Session fest.

6 Falls relevant, wählen Sie eine Fader Gain-
Stufe für die kopierte Session aus.

7 Wählen Sie Enforce Mac/PC Compatibility, um 
Session- und Audiodateien zu erstellen, die 
sowohl auf Windows- als auch auf Mac-
basierten Pro Tools-Systemen verwendet 
werden können (siehe „Speichern von mit 
Windows kompatiblen Kopien von 
Mac-Sessions“ auf Seite 391).

8 Wählen Sie unter Items to Copy die Elemente 
aus, die in die neue Session kopiert 
werden sollen.

9 Klicken Sie auf Save. 

Weitere Informationen zur gemeinsamen 
Nutzung von Sessions auf verschiedenen 
Plattformen, Pro Tools-Systemen oder in 
verschiedenen Versionen der Pro Tools-
Software finden Sie unter Kapitel 18: „Datei-
/Sessionverwaltung und -kompatibilität.“

„Session-Kopie speichern“-Dialogfeld

Wählen Sie die All Audio Files-Option, 
um das gesamte in der Session verwendete 
Audiomaterial einzufügen.
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Verwendung des Save Copy 
In-Befehls
Im Gegensatz zum Save As-Befehl wird die 
Original-Session mit Save Copy In nicht 
geschlossen, d. h., Bearbeitungen werden in der 
Folge an der Original-Session vorgenommen. 
Session-Kopien dienen zum Archivieren von 
wichtigen Sessions, zur Versionierung oder zur 
Vorbereitung von Sessions für die Übertragung in 
ein anderes Pro Tools-System.

Mit Save Copy In wird nur das in der Session 
verwendete Audiomaterial gespeichert. 
Audiomaterial, das aufgenommen oder importiert 
und später aus der Session entfernt, aber nicht von der 
Festplatte gelöscht wurde, wird nicht mit der neuen 
Kopie der Session gespeichert.

Nur durch Verwendung von Save Copy In kann die 
Samplerate einer Session geändert werden. Die 
Samplerate aller kopierten Audiodateien der 
Session wird in die ausgewählte Samplerate 
konvertiert. Beim Speichern einer Session-Kopie 
in einer anderen Samplerate verwendet Pro Tools 
die ausgewählte Sample Rate Conversion Quality-
Option im Import-Bereich der Processing 
Preferences-Registerkarte (Setup > Preferences).

Wenn Sie eine Kopie der Session mit einer 
niedrigeren Bitrate speichern, werden Dither und 
Rauschformung angewendet. Informationen dazu 
entnehmen Sie der folgenden Tabelle:

Die Dither-Einstellung zum Konvertieren ist das 
Dither-Plug-In (Noise Shaping aktiviert).

Wählen Sie die All Audio Files-Option, 
um das gesamte in der Session verwendete 
Audiomaterial einzufügen.

Dither und Rauschformung beim Save Copy In-Befehl

Bit Depth Dither Rauschformung

32-Bit-Gleitkomma 
auf 32-Bit-
Gleitkomma

Ja Ja

32-Bit-Gleitkomma 
auf 24 Bit

Ja Ja

32-Bit-Gleitkomma 
auf 16 Bit

Ja Ja

32-Bit-Gleitkomma 
auf 8 Bit

Ja Nein

24 Bit auf 32-Bit-
Gleitkomma

Nein Nein

24 Bit auf 24 Bit Nein Nein

24 Bit auf 16 Bit Ja Ja

24 Bit auf 8 Bit Ja Nein

16 Bit auf 32-Bit-
Gleitkomma

Nein Nein

16 Bit auf 24 Bit Nein Nein

16 Bit auf 16 Bit Nein Nein

16 Bit auf 8 Bit Ja Nein

Weitere Informationen zum Dithering finden 
Sie unter „Dither“ auf Seite 1032.
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Save Copy In-Optionen
Beim Speichern der Kopie einer Session bietet der 
Save Copy In-Befehl verschiedene Optionen.

Session-Format

Beim Speichern einer Kopie der Session mit dem 
Save Copy In-Befehl können Sie die Session-
Kopie je nach Plattform in den folgenden 
Formaten speichern:

Mac:

• Latest; unterstützt Sessions aus Pro Tools 10.x 
und höher (PTX)

• Pro Tools 7.x-Session -> 9.x-Session (PTF)

• Pro Tools 5.1-Session -> 6.9-Session 

• Pro Tools 5.0-Session 

• Pro Tools 4-24-Bit-Session 

• Pro Tools 4-16-Bit-Session 

• Pro Tools 3.2-Session 

Windows:

• Latest; unterstützt Sessions aus Pro Tools 10.x 
und höher (PTX)

• Pro Tools 7.x-Session -> 9.x-Session (PTF)

• Pro Tools 5.1-Session -> 6.9-Session 

• Pro Tools 5.0-Session 

Session-Parameter

Beim Speichern der Kopie einer Session mit dem 
Save Copy In-Befehl sind folgende Session-
Parameter verfügbar:

Audio File Type

Sie können die Session als BWF(.WAV)- oder 
AIFF-Audiodateien speichern.

Verwenden unterschiedlicher Dateitypen

In einer Session können auch unterschiedliche 
Audiodateitypen verwendet werden. Wenn die 
ursprüngliche Session unterschiedliche Dateitypen 
aufweist, werden diese nicht in den ausgewählten 
Dateityp konvertiert, es sei denn, Sie geben eine 
Konvertierung an, indem Sie die Convert to 

Specified Format-Option im Items To Copy-
Bereich auswählen (siehe „Zu kopierende 
Elemente“ auf Seite 167). 

Bit Depth

Sie können die Session bei einer Bitrate von 16 Bit, 
24 Bit oder 32 Bit Float (Gleitkomma) speichern.

Pro Tools 10.0 und höher können Audiodateien 
mit unterschiedlichen Bitrates verwenden. Wenn 
die ursprüngliche Session unterschiedliche 
Bitrates aufweist, werden diese nicht in die 
ausgewählte Bitrate konvertiert, es sei denn, 
Sie geben eine Konvertierung an, indem Sie die 
Convert to Specified Format-Option im Items To 
Copy-Bereich auswählen (siehe „Zu kopierende 
Elemente“ auf Seite 167).

Wenn Ihre Session beim Speichern in ein Session-
Format unter Version 10.0 eine abweichende 
Bitrate hat, werden die Audiodateien in die Bitrate 
der neuen Session konvertiert und an den 
festgelegten Ort kopiert. 32-Bit-Gleitkomma ist 
für Session-Formate unter 10.0 nicht verfügbar.

Beim Speichern von Sessions in einem 
früheren Format als Pro Tools 5.1 gehen 
sämtliche Mehrkanalspuren (einschließlich 
Stereo) und Multimono-Plug-Ins verloren. 
Trennen Sie in diesem Fall die Spuren und 
Plug-Ins in einzelne Monospuren, bevor Sie 
die Session im Pro Tools 5.0-Format oder 
niedriger speichern.

Weitere Informationen zum Bouncen auf die 
Festplatte und zum Dithering finden Sie unter 
„Verwenden von Dither“ auf Seite 1138.
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Sample Rate

Je nach Hardware Ihres Systems können Sie die 
Session mit unterschiedlichen Samplerates 
speichern. Siehe „Unterstützte Hardware-
Konfigurationen mit Pro Tools-Software“ auf 
Seite 40. 

Wenn Ihre Session eine andere Samplerate hat, 
werden die Audiodateien in die Samplerate der 
neuen Session konvertiert und an den angegebenen 
Speicherort kopiert.

Fader Gain

Wenn Sie eine Session aus Pro Tools 7.x oder 
höher in einer älteren Version von Pro Tools 
speichern, die +12 dB als Fader-Verstärkung 
unterstützt, können Sie für die neue Session 
entweder +6 dB oder +12 dB als maximale Fader-
Verstärkung wählen. Wenn Sie eine Session mit 
+12 dB als eine Session mit +6 dB speichern, 
werden eventuell vorhandene Automationen über 
+6 dB auf +6 dB reduziert.

Enforce Mac/PC Compatibility

Wenn Sie eine Session aus Pro Tools 7.x oder 
höher in einer älteren Version von Pro Tools 
speichern, aktivieren Sie die Enforce Mac/PC 

Compatibility-Option, damit sowohl in Windows- 
als auch in Mac-Versionen von Pro Tools Sessions 
und Audiodateien erstellt werden, die auf beiden 
Plattformen kompatibel sind. 

Limit Character Set

Wenn Sie die Kopie einer Session im aktuellen 
Session-Format speichern, können Sie mithilfe der 
Limit Character Set-Option den Zeichensatz auf 
eine einzige Sprache beschränken.

Wenn Sie eine Kopie einer Session in einem 
älteren Session-Format speichern, ist die Limit 

Character Set-Option automatisch ausgewählt. 
Wählen Sie im Limit Character Set-Popup-Menü 
die gewünschte Sprache.

So wählen Sie die Sprachkodierung beim 
Speichern einer Session-Kopie: 

1 Wählen Sie File > Save Copy In. 

2 Wählen Sie die Limit Character Set-Option. 

3 Wählen Sie im Limit Character Set-Popup-
Menü die Sprache aus, die Sie 
verwenden möchten. 

Zu kopierende Elemente

Beim Speichern einer Kopie der Session mit dem 
Save Copy In-Befehl können Sie die zu 
kopierenden Elemente über die folgenden 
Optionen auswählen:

Audiodateien

Wenn diese Option ausgewählt ist, werden alle 
Audiodateien in den neuen Ordner kopiert. Diese 
Einstellung wird automatisch gewählt, wenn Sie 
ein Session-Format niedriger als 10.0 auswählen.

Konvertieren in das angegebene Format

Bei aktivierter Convert To Specified Format-
Option werden alle kopierten Audiodateien in das 
Audiodateiformat konvertiert, das unter Session-
Parameter festgelegt ist. Ist diese Option nicht 
ausgewählt, behalten alle kopierten Audiodateien 
ihre ursprünglichen Dateiformateinstellungen 
(einschließlich Samplerate und Bittiefe) bei und 
werden Bit für Bit ganz genau kopiert.

Weitere Informationen finden Sie unter 
„Speichern von mit Windows kompatiblen 
Kopien von Mac-Sessions“ auf Seite 391.

Beachten Sie, dass das Bit-für-Bit-Kopieren 
von Formaten wesentlich schneller ist als das 
Konvertieren von Dateien.
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Diese Option wird automatisch ausgewählt, wenn 
Sie einen der folgenden Schritte ausführen:

• Speichern Sie in einem niedrigeren Session-
Format als 10.0.

• Aktivieren Sie Enforce Mac/PC Compatibility.

Don't Copy Elastic Audio Rendered Files

Ist diese Option aktiviert, werden Elastic Audio 
Rendered-Dateien nicht in den Rendered Files-
Ordner der neuen Session kopiert. 

Wenn Sie die neue Session aufrufen, öffnet Pro Tools 
die kopierte Session mit allen verfügbaren Medien. 
Sämtliche fehlenden Rendered-Dateien werden 
automatisch regeneriert.

Nur Haupt-Playlist

Ist diese Option aktiviert, werden nur Haupt-
Playlists in der Session-Kopie berücksichtigt. 
Alternative Playlists werden in der Session-Kopie 
nicht gespeichert.

Ist diese Option deaktiviert, werden alle Playlists 
in die Session-Kopie übernommen.

Nur ausgewählte Spuren

Bei aktivierter Option werden nur die in der Quell-
Session ausgewählten Spuren in der Session-
Kopie gespeichert. Diese Option ist automatisch 
aktiviert, wenn Sie File > Export > Selected Tracks 

As New Session wählen.

Ist diese Option deaktiviert, werden alle Spuren 
aus der Quell-Session in die Session-Kopie 
übernommen. Diese Option ist automatisch 
deaktiviert, wenn Sie File > Save Session 

Copy wählen.

Session Plug-In Settings Folder

Wenn Sie diese Option wählen, wird der Plug-In 
Settings-Ordner der Session an den neuen 
Speicherort kopiert. Die Referenzen auf diese 
Plug-In-Einstellungen in der Session verweisen 
nun auf die kopierten Einstellungsdateien.

Root Plug-In Settings Folder

Ist diese Option aktiviert, wird der Inhalt des Plug-
In Settings-Ordners im Stammverzeichnis in einen 
Ordner mit dem Namen Place in Root Settings 
Folder kopiert, als Hinweis, dass diese Dateien vor 
Verwendung zunächst in den Plug-In Settings-
Ordner des dortigen Stammverzeichnisses 
verschoben werden müssen. Die Referenzen auf 
diese Einstellungsdateien in der Session werden 
nicht geändert, um auf die kopierten Dateien zu 
verweisen.

Movie/Video Files

Ist diese Option aktiv, werden Session-
Videodateien (Avid oder QuickTime) an den 
neuen Speicherort kopiert und die Session-
Referenzen aktualisiert, sodass sie auf die 
kopierten Videodateien verweisen.

Preserve Folder Hierarchy

Wenn diese Option ausgewählt ist, wird die 
relative Anordnung von Audiodateien der Session, 
die sich auf verschiedenen Laufwerken oder in 
unterschiedlichen Ordnern befinden, beibehalten. 
Der Hauptordner für die Session-Kopie enthält 
Unterordner für jedes Laufwerk bzw. jeden Ordner 
der Original-Session. Die Ziel-Unterordner 
verwenden dieselben Namen wie die Quell-
Laufwerke und -Ordner.

Wenn diese Option nicht ausgewählt ist, werden 
durch den Save Copy In-Befehl alle Dateien 
desselben Typs unabhängig von ihrem Speicherort 
in einen einzigen Zielordner kopiert. 
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Session-Vorlagen
Neben den Session-Vorlagen, die im Quick Start-
Dialogfeld für Pro Tools-Sessions verfügbar sind, 
können Sie mit Pro Tools eigene benutzerdefinierte 
Session-Vorlagen erstellen und für andere Benutzer 
freigeben. Für die Session-Vorlagendateien von 
Pro Tools wird das Suffix PTXT verwendet, um sie 
von den regulären Pro Tools-Session-Dateien (PTX) 
zu unterscheiden.

Erstellen und Speichern 
benutzerdefinierter Vorlagen

So erstellen Sie eine benutzerdefinierte Pro Tools-
Session-Vorlage:

1 Erstellen Sie eine neue Pro Tools-Session und 
konfigurieren Sie sie für die gewünschte 
Session-Vorlage. 

2 Wählen Sie File > Save As Template.

3 Nehmen Sie im Save Session 
Template-Dialogfeld die erforderlichen 
Einstellungen vor (siehe „Save Session 
Template-Dialogfeld“ auf Seite 169).

4 Wählen Sie die Include Media-Option aus, wenn 
Sie Audio-, MIDI- oder Videomedien aus der 
Session in die Vorlage aufnehmen möchten. 

5 Klicken Sie auf OK.

Wenn Sie die Install Template In System-Option 
ausgewählt haben, ist die Session-Vorlage im 
Quick Start-Dialogfeld für Pro Tools-
Sessions verfügbar. 

Wenn Sie die Select Location For Template-
Option ausgewählt haben, müssen Sie im Save As 
Template-Dialogfeld für die Datei einen anderen 
Speicherort im System angeben.

Save Session Template-
Dialogfeld
Das Save Template-Dialogfeld bietet die 
folgenden Optionen:

Install Template In System

Wählen Sie diese Option aus, um die 
Vorlagendatei in dem Systemordner zu speichern, 
der im Quick Start-Dialogfeld für Pro Tools-
Sessions („Session Templates“ im Pro Tools-
Anwendungsordner) angegeben ist.

Als Songwriter benötigen Sie möglicherweise 
nur eine Session, die aus einer Stereo-
Instrumentenspur mit einem Instrumenten-Plug-
In (wie Xpand! 2 mit Piano-Voreinstellung), 
einer Mono-Audiospur (für Gesang), einer 
Stereo-Auxiliary-Eingangs-Spur (für einen 
Effekt-Bus) und einer Stereo-Master-Fader-
Spur erstellen. Immer wenn Sie dann an einem 
neuen Song arbeiten, können Sie diese Vorlage 
verwenden.

Save Session Template-Dialogfeld

Wenn die Include Media-Option aktiviert ist, 
werden alle Medien in der Session in die 
Vorlage aufgenommen. Wenn Sie Medien in 
Ihre Session-Vorlage aufnehmen möchten, 
achten Sie darauf, dass die Session nur die 
gewünschten Medien enthält.

Informationen zur Verwendung einer Vorlage 
bei der Erstellung einer neuen Session finden 
Sie unter „Erstellen einer neuen Session aus 
einer Vorlage“ auf Seite 156.
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Kategorie

Das Category-Popup-Menü ist nur verfügbar, 
wenn die Install Template In System-Option 
aktiviert ist. Im Category-Popup-Menü können Sie 
einen Unterordner zum Speichern der 
Vorlagendatei auswählen. Es bietet auch Optionen 
zum Hinzufügen einer Kategorie und zum 
Anzeigen des Session Templates-Ordners im 
Windows Explorer oder Mac Finder.

Add Category. – wählen Sie diese Option 
im Category-Popup-Menü aus, um im Session 
Templates-Ordner einen neuen Unterordner 
zu erstellen.

Name

Die Name-Einstellung ist nur verfügbar, wenn die 
Install Template In System-Option aktiviert ist. 
Hier können Sie einen neuen Namen für die 
Vorlagendatei eingeben. Aus dem Name-Popup-
Menü (rechts neben dem Name-Feld) können Sie 
aus einer Liste aller derzeit in der ausgewählten 
Kategorie verfügbaren Vorlagen eine Auswahl 
treffen. Durch die Auswahl wird dieser Name in 
das Name-Feld übernommen. So können Sie ihn 
überschreiben oder eine abgewandelte Version 
einer vorhandenen Vorlage erstellen.

Select Location For Template

Wählen Sie diese Option, um die Vorlagendatei in 
einem beliebigen Ordner im System zu speichern. 
Beachten Sie, dass die gespeicherte Session-Vorlage 
nur im Quick Start-Dialogfeld für Pro Tools-
Sessions angezeigt wird, wenn sie sich im Session 
Templates-Unterordner (Kategorie) des Pro Tools-
Ordners „Root Settings“ befindet. Sie können den 
Speicherort des Root Settings-Ordners unter 
„Operation Preferences“ ändern (siehe „User 
Library-Abschnitt“ auf Seite 110).

Include Media

Wählen Sie diese Option, um Audio-, MIDI- oder 
Videomedien aus der Session in die 
Vorlage aufzunehmen.

Erstellen neuer Sessions aus 
Vorlagen
Sie können neue Sessions aus Vorlagen erstellen, 
indem Sie eine Vorlage öffnen. Sie können eine 
beliebige Session-Vorlagendatei aus Pro Tools 
(.ptt) öffnen, um eine neue Session basierend auf 
der Vorlage zu starten.

Schließen einer Session
In Pro Tools können Sie immer nur an einer 
Session arbeiten. Mit dem Close Session-Befehl 
wird die aktuelle Pro Tools-Session geschlossen, 
wobei die Anwendung jedoch geöffnet bleibt. 
Beim Schließen einer Session in Pro Tools werden 
Sie aufgefordert, die Datei zu speichern. Es 
empfiehlt sich jedoch, Ihre Arbeit ungeachtet 
dessen schon vor dem Schließen über die Befehle 
Save oder Save As zwischenzuspeichern.

So schließen Sie eine Session:

 Wählen Sie File > Close Session.

Beenden von Pro Tools
Wenn Sie die Pro Tools-Anwendung beenden, 
werden Sie von Pro Tools dazu aufgefordert, die 
jeweilige offene Session vor dem Beenden 
zu speichern.

So beenden Sie Pro Tools unter Windows:

 Wählen Sie File > Exit.

So beenden Sie Pro Tools auf einem Mac:

 Wählen Sie Pro Tools > Quit Pro Tools.

Weitere Informationen zum Erstellen neuer 
Sessions aus Vorlagen über das Quick Start-
Dialogfeld finden Sie unter „Erstellen einer 
neuen Session aus einer Vorlage“ auf 
Seite 153.
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Kapitel 12: Hauptfenster in Pro Tools

Pro Tools bietet zwei Möglichkeiten 
zur Darstellung von Spuren in einer Session, 
die sich gegenseitig ergänzen: 

Mix-Fenster – die Spuren werden in Form von 
Kanalzügen abgebildet, wie bei einem Mischpult 
(siehe „Mix-Fenster“ auf Seite 172).

Edit-Fenster – die Spuren und das Spurmaterial 
werden bezogen auf die Timeline angezeigt (siehe 
„Edit-Fenster“ auf Seite 174). 

Um zwischen dem Mix- und dem Edit-Fenster zu 
wechseln, drücken Sie die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac) und 
das Gleichheitszeichen (=).

Pro Tools-Fenster

Edit-Fenster

Mix-Fenster

Transport-Fenster

Plug-In-Fenster

Workspace-Browser
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Pro Tools bietet verschiedene andere Typen 
von Fenstern:

Transport-Fenster – ermöglicht die Steuerung des 
Transports und vieler damit verbundener 
Funktionen (siehe „Transport-Fenster“ auf 
Seite 179).

Plug-In-Fenster – hier können Sie Plug-In-
Parameter wie Frequenz und Q für ein EQ steuern 
(siehe „Plug-In-Fenster“ auf Seite 1046). 

MIDI Editor-Fenster – hier können Sie MIDI-
Daten bearbeiten (siehe Kapitel 32: „MIDI-
Editoren“).

Noten-Editor-Fenster – hier können Sie MIDI-
Daten in Notenschrift bearbeiten (siehe 
Kapitel 33: „Score Editor“).

Workspace-Browser – hier können Sie Medien für 
Pro Tools-Sessions verwalten, abhören und 
importieren (siehe „Workspace-Browser“ auf 
Seite 281).

Webbrowser innerhalb der Anwendung – 
ermöglichen den direkten Zugriff auf den Avid 
Marketplace und Pro Tools-Online (siehe 
„Webbrowser-Funktion innerhalb der 
Anwendung“ auf Seite 186).

Mix-Fenster
Im Mix-Fenster erscheinen Spuren als Kanalzüge 
wie eine Mischkonsole, mit Steuerelementen für:

• Inserts

• Sends

• Eingangs- und Ausgangszuweisungen

• Volume

• Panning

• Scharfschaltung

• Abhören des Spureingangs

• Automationsmodus

• Solo- und Stummschaltung

• Instrument-Steuerelemente

• HEAT-Steuerelemente (nur Pro Tools HD)

• Mic-Preamps

So blenden Sie das Mix-Fenster ein:

 Wählen Sie Window > Mix.

So zeigen Sie die Darstellungsoptionen im Mix-
Fenster an:

 Wählen Sie View > Mix Window > All.

Weitere Informationen zu einzelnen 
Darstellungsoptionen finden Sie unter 
„Bedienfelder im Mix- und Edit-Fenster“ 
auf Seite 991.
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Pro Tools – Mix-Fenster

Inserts-
Bedienfeld 
(Seite 993)

Tracks-Liste 
(Seite 232)

Lautstärke
-Fader 

(Seite 211)

Pan-
Drehregler 
(Seite 211)

Pegelanzeige 
(Seite 212)

Auxiliary-
Eingang 

(Seite 204)

Delay 
Compensation-

Bedienfeld 
(Seite 994)

Master-
Fader 

(Seite 204)

AutoMatch-
Anzeige 

(Seite 1084)

Track Path-Selektoren 
(Seite 236 und 

Seite 243)

Mono-
Audiospur 
(Seite 202)

MIDI
Spur 

(Seite 205)

Sends-
Bedienfeld 
(Seite 993)

Automation 
Mode-Selektor 
(Seite 1074)

Track 
Comments-
Darstellung 
(Seite 992)

Voice-Selektor 
(Seite 242)

Spurname 
(Seite 222)

Mix Group-Liste 
(Seite 255)

Gruppen-ID-
Anzeige 

(Seite 259)

Instrumenten-
spur 

(Seite 206)

Instrument-
Bedienfeld 
(Seite 993)

Ansichts-
Selektor des 
Mix-Fensters
(Seite 991)

Tracks-Liste/Groups-
Liste ein-/ausblenden 

(Seite 232)

Kanalzüge 
(Seite 203)

Solo/Mute 
(Seite 246)

Eingangs-
Monitoring/

Scharfschalten 
(Seite 448 und 

Seite 442)

Stereo-
Audiospur 
(Seite 202)
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Edit-Fenster
Das Edit-Fenster bietet eine Timeline-Ansicht von 
Audio, Video und MIDI-Noten sowie andere 
MIDI-Daten und Mischautomation zum 
Aufnehmen, Editieren und Anordnen von Spuren. 
Jede Spur hat wie im Mix-Fenster Steuerelemente 
zum Scharfschalten, zum Solo- und 
Stummschalten und für den Automationsmodus.

Pro Tools – Edit-Fenster

Zeitbasis- und 
Dirigenten-

Leisten 
(Seite 791)

Clipliste 
(Seite 269)

Tracks-Liste 
(Seite 232)

Edit-Modus-
Schaltflächen 
(Seite 543)

Edit-Tools 
(Seite 547)

Zoom-Schaltflächen (Seite 548)

Zähler und Edit-
Selektions-Anzeigen

(Seite 589)

Raster- und 
Nudge-Werte 
(Seite 176)

MIDI Editor-
Arbeitsbereich 

(Notationsdarstellung, 
Seite 184)

MIDI Controller-
Lanes (Seite 753)

Selektierter Clip 
(Seite 578)

Edit Group-
Liste 

(Seite 797)

Transport-
Steuerelemente 

(Seite 179)

Edit-Fenster-
Symbolleiste und 
-Menü (Seite 175)

Spuren 
(Seite 201)

Playlists-
Darstellung 
(Seite 651)

Elastic Audio-Warp-
Spurdarstellung 

(Seite 901)

Automation 
(Seite 1071)

Universe-
Darstellung 
(Seite 592)

Zoom-
Schaltflächen im 

Edit-Fenster 
(Seite 178)
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So blenden Sie das Edit-Fenster ein:

 Wählen Sie Window > Edit.

So zeigen Sie die Darstellungsoptionen im Edit-
Fenster an:

 Wählen Sie View > Edit Window > All. 

Die Darstellungsoptionen im Edit-Fenster können 
einzeln ausgewählt werden. Siehe „Bedienfelder im 
Mix- und Edit-Fenster“ auf Seite 991.

Symbolleiste des Edit-Fensters
Oben im Edit-Fenster befindet sich die 
Symbolleiste des Edit-Fensters und deren Menü. 
Über diese Symbolleiste haben Sie Zugriff auf die 
Modi, Tools, Optionen und Anzeigen für das 
Editieren in Pro Tools. Sie können die 
Symbolleiste im Edit-, MIDI Editor- oder Score 
Editor-Fenster anpassen, indem Sie die 
verfügbaren Steuerelemente und Anzeigen neu 
anordnen oder ein- oder ausblenden.

Steuerelemente und Anzeigen der Edit-
Symbolleiste

Die folgenden Steuerelemente und Anzeigen 
werden in der Symbolleiste des Edit-Fensters 
immer angezeigt.

Edit-Modi

Der Edit-Modus beeinflusst das Verschieben und 
die Positionierung von Audio- und MIDI-Clips 
(und MIDI-Noten), das Verhalten der Copy- und 
Paste-Befehle und die Funktionsweise der Edit-
Tools „Trim“, „Selector“, „Grabber“ und „Pencil“. 
Weitere Informationen finden Sie unter „Edit-
Modi“ auf Seite 543.

Edit-Tools

Edit-Tools werden für das Bearbeiten von Audio-, 
MIDI- und Automationsdaten in Pro Tools 
verwendet. Weitere Informationen finden Sie 
unter „Edit-Tools“ auf Seite 547.

Zähler und Edit-Selektions-Anzeige

Die Zähler und Edit-Selektions-Anzeige liefern 
Informationen darüber, wo sich Selektionen in der 
Timeline befinden. 

Hauptzähler – zeigt den aktuellen Edit-
Einfügepunkt in der Haupt-Zeitbasis-Leiste an.

Nebenzähler (Sub) – zeigt den aktuellen Edit-
Einfügepunkt in der Sub-Zeitbasis-Leiste an.

Cursor-Position – zeigt die aktuelle Cursor-
Position in der Haupt-Zeitbasis-Leiste an.

Cursor-Wert – zeigt den Wert des aktuellen 
Cursor-Werts in Spitzenamplitude (Audio), 
Tonhöhe (MIDI) oder gemäß dem aktuellen 
Automations- oder Controller-Datentyp an. Edit-Modus-Schaltflächen

Edit-Tools

Anzeigen im Edit-Fenster

Haupt- und Nebenzähler

Edit-Selektion

MIDI-Selektion

Cursor-Position
Mute-Spuranzeige

Solo-Spuranzeige
Cursor-Wert

Online-Status für Timeline-Daten

Online-Status für Session-Daten

Automatischer Verzögerungsausgleich
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Edit-Selektions-Anzeige – zeigt Start, Ende und 
Länge der aktuellen Edit-Selektion an.

MIDI-Selektions-Steuerelemente und -Anzeigen 
– zeigen die aktuelle MIDI-Edit-Selektion (MIDI-
Notennummer sowie Note On- und Note Off-
Velocity-Werte) an und stellen Steuerelemente für 
das MIDI-Editing bereit.

Anzeige für den Online-Status für Timeline-Daten 
– leuchtet grün, wenn alle Dateien der Playlists einer 
Spur für die Wiedergabe zur Verfügung stehen. Falls 
Dateien offline sind, gerade verarbeitet werden oder 
aus anderen Gründen für die Wiedergabe nicht 
verfügbar sind, ist die Anzeige rot.

Anzeige für den Online-Status für Session-Daten 
– leuchet grün, wenn alle Audio- und Fade-Dateien der 
Session für die Wiedergabe zur Verfügung stehen. 
Falls Dateien offline sind, gerade verarbeitet werden 
oder aus anderen Gründen für die Wiedergabe nicht 
verfügbar sind, ist die Anzeige rot.

Statusanzeige für den Verzögerungsausgleich – 
wird angezeigt, wenn Delay Compensation 
aktiviert ist (Options > Delay Compensation). 
Bei deaktivierter Delay Compensation-Funktion 
erscheint diese Anzeige nicht.

Solo-Spuranzeige – leuchtet gelb, wenn Spuren in 
der Session solo geschaltet sind. Wenn in der 
Session keine Spuren solo geschaltet sind, ist die 
Solo-Spuranzeige grün abgeblendet. Bei Systemen 
mit Satellite Link leuchtet die Solo-Spuranzeige 
gelb abgeblendet, wenn eine Spur auf einem 
Satellite-System solo geschaltet ist.

Wenn die Solo-Spuranzeige leuchtet, können Sie 
darauf klicken, um alle Soloschaltungen in der 
Session aufzuheben.

Mute-Spuranzeige – leuchtet orange, wenn Spuren 
in der Session stummgeschaltet sind. Wenn keine 
Spuren in der Session stummgeschaltet sind, ist die 
Solo-Spuranzeige grün abgeblendet. (Beachten 
Sie: Da Mute eine automatisierbare Mixfunktion 
ist, können Sie nicht durch Anklicken der Mute-
Spuranzeige alle Mute-Schaltungen aufheben.)

Grid und Nudge

Über die Grid- und Nudge-Selektoren können Sie die 
Raster- und Nudge-Werte für das Editieren in 
Pro Tools festlegen. Weitere Informationen zum 
Grid Value-Selektor finden Sie unter „Konfigurieren 
des Rasters“ auf Seite 546. Weitere Informationen 
zum Nudge Value-Selektor finden Sie unter 
„Festlegen des Nudge-Werts“ auf Seite 607.

Ein- und Ausblenden zusätzlicher 
Steuerelemente im Edit-Fenster

So blenden Sie Steuerelemente in der 
Symbolleiste des Edit-Fensters ein oder aus:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf das Symbolleistenmenü des 
Edit-Fensters (oben rechts).

• Klicken Sie mit der rechten Maustaste auf 
die Symbolleiste.

Selektoren für Raster- und Nudge-Werte

Symbolleistenmenü im Edit-Fenster

Grid Value-Selektor

Nudge Value-Selektor
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2 Aktivieren oder deaktivieren Sie jeweils 
die folgenden Optionen, je nach konfiguriertem 
Fenster:

Zoom Controls – bei Auswahl dieser Option werden 
die Zoom-Steuerelemente in der Symbolleiste des 
Edit-Fensters angezeigt.

Transport – bei Auswahl dieser Option werden die 
Transport-Steuerelemente in der Symbolleiste des 
Edit-Fensters angezeigt.

MIDI Controls – bei Auswahl dieser Option 
werden die MIDI-Steuerelemente in der 
Symbolleiste des Fensters angezeigt.

Synchronization – bei Auswahl dieser Option 
werden die Synchronisations-Steuerelemente und 
-anzeigen in der Symbolleiste des Edit-Fensters 
angezeigt.

Output-Anzeige – bei Auswahl dieser Option 
werden die Ausgangspegelanzeigen in der 
Symbolleiste des Edit-Fensters angezeigt.

Eleven Rack (nur Eleven Rack) Diese Option ist 
nur verfügbar, wenn ein Eleven Rack-Gerät mit 
Ihrem Pro Tools-System verbunden ist. – bei 
Auswahl dieser Option werden die Eleven Rack-
Steuerelemente in der Symbolleiste des Edit-
Fensters angezeigt. Weitere Informationen hierzu 
finden Sie im Eleven Rack-Benutzerhandbuch.

Minimal – bei Auswahl dieser Option werden 
die Zoom-, Transport-, MIDI- und 
Synchronisations-Steuerelemente nicht in der 
Symbolleiste des Edit-Fensters angezeigt.

All – bei Auswahl dieser Option werden die 
Zoom-, Transport-, MIDI- und Synchronisations-
Steuerelemente alle in der Symbolleiste des Edit-
Fensters angezeigt.

Expanded Transport – bei Auswahl dieser 
Option werden die erweiterten Transport-
Steuerelemente in der Symbolleiste des Edit-
Fensters angezeigt, sofern auch „Transport“ 
ausgewählt ist.
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Spurenliste – bei Auswahl dieser Option wird die 
Tracks-Liste auf der linken Seite des Edit-Fensters 
angezeigt.

Clip List – bei Auswahl dieser Option wird 
die Clipliste auf der rechten Seite des 
Edit-Fensters angezeigt.

Universe – bei Auswahl dieser Option wird die 
Universe-Darstellung nahe des oberen Rands des 
Edit-Fensters angezeigt.

MIDI-Editor – bei Auswahl dieser Option wird das 
MIDI Editor-Bedienfeld am unteren Rand des 
Edit-Fensters angezeigt.

Neuanordnen von 
Steuerelementen und Anzeigen

So ordnen Sie Steuerelemente und Anzeigen in 
der Symbolleiste des Edit-, MIDI Editor- oder Score 
Editor-Fensters neu an:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf die 
Steuerelemente bzw. Anzeigen, die Sie 
verschieben möchten, und ziehen Sie sie an eine 
neue Position in der Symbolleiste.

Wenn beispielsweise die Zähler und Edit-Selektions-
Anzeige in der Symbolleiste rechts neben den 
Transport-Steuerelementen stehen sollen, klicken Sie 
bei gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) darauf und ziehen Sie sie rechts 
neben die Transport-Steuerelemente.

Zoom-Schaltflächen 
im Edit-Fenster
Im Edit-Fenster befinden sich auch Zoom-
Schaltflächen in der oberen rechten und in der 
unteren linken Ecke des Tracks-Fensterbereichs.

Schaltflächen für das vertikale und horizontale 
Vergrößern und Verkleinern

Zusätzlich zu den Zoom-Steuerelementen in der 
Symbolleiste befinden sich in Pro Tools rechts 
unten im Edit-Fenster Schaltflächen für das 
horizontale und vertikale Vergrößern und 
Verkleinern (Zoom). 

Schaltflächen für vertikalen Zoom – damit 
können Sie die Spurhöhe proportional im Edit-
Fenster zoomen.

Schaltflächen für horizontalen Zoom – damit 
zoomen Sie die Timeline genau wie mit den 
horizontalen Zoom-Steuerelementen in der 
Symbolleiste des Edit-Fensters.

Verschieben der Zähler und Edit-Selektions-Anzeige

Vertikale Zoom-Schaltflächen (Edit-Fenster)

Horizontale Zoom-Schaltflächen (Edit-Fenster)
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Audio- und MIDI-Zoomschaltflächen

Pro Tools enthält außerdem oben rechts im Edit-Fenster 
Audio- und MIDI-Zoom-In- und -Out-Schaltflächen. 
Diese Steuerelemente haben genau dieselbe 
Funktionsweise wie die Audio- und MIDI-Zoom-
Steuerelemente in der Symbolleiste und ermöglichen 
das vertikale Vergrößern und Verkleinern von Audio-
Wellenformen bzw. MIDI-Noten.

Standardlänge des Edit-Fensters
In Pro Tools können Sie für das Edit-Fenster eine 
Standardlänge in Stunden, Minuten, Sekunden und 
Frames einstellen. Diese Funktion ist besonders 
dann nützlich, wenn Sie eine Session mit einer 
bestimmten Länge zusammenstellen oder aber 
zusätzlichen Platz haben möchten, um für die 
Session den Arbeitsbereich im Edit-Fenster zu 
vergrößern. Bei 48 kHz beträgt die maximal 
mögliche Dauer 12 Stunden und 25 Minuten, 
bei höheren Samplerates ist sie proportional kürzer. 
Zur Erreichung einer optimalen Empfindlichkeit 
der Bildlaufleiste stellen Sie diesen Wert etwas 
höher ein (um eine Minute oder mehr) als die Dauer 
der Gesamt-Session oder des Songs.

So legen Sie den Standardwert für das 
Edit-Fenster fest:

1 Wählen Sie Setup > Preferences.

2 Geben Sie auf der Display-Registerkarte den 
Wert in Stunden, Minuten, Sekunden und 
Frames für die Edit Window Default Length-
Einstellung ein.

3 Klicken Sie auf OK.

Transport-Fenster
Das Transport-Fenster lässt sich so einstellen, dass die 
grundlegenden Transport-Steuerelemente, Zähler, 
MIDI-Steuerelemente und die erweiterten Funktionen 
angezeigt werden. Die Zähler im Transport-Fenster 
geben dieselben Werte wieder wie die 
Positionsanzeigen oben im Edit-Fenster.

So zeigen Sie das Transport-Fenster an:

 Wählen Sie Window > Transport.

Grundlegende Transport-
Steuerelemente und -Zähler

Der vertikale MIDI-Zoom im Edit-Fenster 
wirkt sich nur auf Spuren aus, die sich nicht 
in der Clip-Ansicht befinden.

Audio-Zoom-Schaltfläche (Edit-Fenster)

MIDI-Zoom-Schaltfläche (Edit-Fenster)

Transport-Fenster mit den grundlegenden 
Steuerelementen und Zählern (Haupt- und 
Nebenzähler und MIDI nicht abgebildet)

Start, End, Length
Selektions-Anzeigen

Online

Rewind

Schnellvorlauf (Fast Forward) Stopp
Play

Auf-
nahme

Zurück zu Null

Zum Ende

Pre-
Roll
Post-
Roll

Record Enable-Anzeige einer Spur

TrackInput Monitor 
(Anzeige)

Menü des Transport-Fensters
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Online – schaltet Pro Tools auf die Betriebsart 
„Online“; Aufnahme und Wiedergabe werden 
dann durch eine externe Timecode-Quelle 
ausgelöst.

Return to Zero – springt zum Startpunkt 
der Session.

Rewind – spult von der aktuellen 
Wiedergabeposition zurück. Sie können auch 
wiederholt auf die Schaltfläche klicken, 
um schrittweise zurückzuspulen. Der zurückgespulte 
Abschnitt wird dabei vom eingestellten Zeitformat 
der Haupt-Zeitskala bestimmt:

Fast Forward – bewirkt schnelles Vorspulen vom 
Timeline-Einfügepunkt aus. Sie können auch 
wiederholt auf diese Schaltfläche klicken, 
um schrittweise vorzuspulen (abhängig vom 
Zeitformat der Haupt-Zeitskala).

Go to End – springt zum Endpunkt der Session.

Stop – stoppt die Wiedergabe oder die Aufnahme.

Play – startet die Wiedergabe oder, falls die Record-
Schaltfläche vorher angeklickt wurde, die Aufnahme 
vom Timeline-Einfügepunkt oder von der Position 
des Wiedergabestart-Markers aus, falls der Dynamic 
Transport-Modus aktiviert ist.

Wenn Sie mit der rechten Maustaste auf die Play-
Schaltfläche klicken, können Sie den 
Wiedergabemodus in einem Popup-Menü auswählen:

• Half-Speed

• Vorbereitung für Wiedergabe

• Loop

• Dynamischer Transport

Drücken Sie die Eingabe- (Windows) bzw. 
Return-Taste (Mac), um zum Startpunkt der 
Session zu springen.

Sie können mit der rechten Maustaste auf 
die „Zurück zu Null“-Schaltfläche klicken, 
um auf die Automationsbefehle „Write to 
Start“ und „Write to All“ zuzugreifen.

Wenn sich der Ziffernblock im Transport-
Modus befindet, können Sie durch Drücken 
der Taste 1 zurückspulen.

Schrittgrößen beim Zurück- und Vorspulen

Haupt-Zeitskala-Format Schrittgröße

Min:Sec 1 Sekunde

Timecode 1 Frame

Bars|Beats 1 Bar (Takt)

Feet+Frames 1 Foot

Sample 1 Sekunde

Wenn sich der Ziffernblock im Transport-
Modus befindet, können Sie durch Drücken 
der Taste 2 vorspulen.

Sie können auch auf der alphanumerischen 
Tastatur Strg + Eingabe (Windows) bzw. 
Wahl + Return (Mac) drücken, um zum 
Endpunkt der Session zu springen.

Sie können mit der rechten Maustaste auf die 
„Zum Ende“-Schaltfläche klicken, um auf die 
Automationsbefehle „Write to End“ und 
„Write to All“ zuzugreifen.

Sie können den Transport auch stoppen, indem 
Sie die Leertaste drücken, oder indem Sie die 
Taste 0 drücken, während sich der Ziffernblock 
im Transport-Modus befindet.

Sie können die Wiedergabe auch starten, 
indem Sie die Leertaste oder, wenn sich der 
Ziffernblock im Transport-Modus befindet, 
die Taste 0 drücken.
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Wenn der Transport gestoppt ist, klicken Sie bei 
gedrückter Windows- (Windows) bzw. Ctrl-Taste 
(Mac) auf die Play-Schaltfläche, um in den Loop 
Playback-Modus zu wechseln. Wenn aktiviert, wird 
ein Loop-Symbol auf der Play-Schaltfläche 
angezeigt und Pro Tools wiederholt die Wiedergabe 
vom Anfang bis zum Ende der Selektion.

Record – schaltet Pro Tools für die Aufnahme 
scharf (die Schaltfläche blinkt). Wenn Sie 
anschließend auf „Play“ drücken, beginnt die 
Aufnahme auf den scharfgeschalteten Spuren.

Wenn Sie mit der rechten Maustaste auf die Record-
Schaltfläche klicken, können Sie den 
Aufnahmemodus in einem Popup-Menü auswählen:

• Normal

• Loop

• Destruktiv

• Der QuickPunch

• TrackPunch (nur Pro Tools HD)

• Destructive Punch (nur Pro Tools HD)

Sie können auch zwischen den Aufnahmemodi von 
Pro Tools wechseln, wenn die Wiedergabe/Aufnahme 
gestoppt ist, indem Sie bei gedrückter Windows- 
(Windows) bzw. Ctrl-Taste (Mac) auf die Record-
Schaltfläche klicken.

Die Darstellung der Record-Schaltfläche ändert 
sich und zeigt so den aktivierten Modus an: leer für 
„Nondestructive“, „D“ für „Destructive“, 
Schleifensymbol für „Loop Record“, „P“ für 
„QuickPunch“, „T“ für „TrackPunch“ und „DP“ 
für „DestructivePunch“.

Track Record Enable-Anzeige – wenn diese LED 
leuchtet (rot), weist dies darauf hin, dass derzeit 
mindestens eine Audiospur für die Aufnahme 
scharfgeschaltet ist. Wenn diese LED nicht 
leuchtet (grau), ist keine Spur scharfgeschaltet. 

TrackInput Monitor-Anzeige – wenn diese LED 
leuchtet (grün), weist dies darauf hin, dass derzeit 
mindestens eine Audiospur auf Input Only-
Abhören geschaltet ist (unabhängig vom 
Scharfschalten für die Aufnahme). Wenn diese 
LED nicht leuchtet (grau), sind alle Spuren auf 
Auto Input-Abhören geschaltet.

Transport-Fenster-Menü – hier können Sie die 
Optionen wählen, die im Transport-Fenster 
angezeigt werden sollen: Counters, MIDI Controls, 
Synchronization, Minimal, All und Expanded 

Transport.

Pre-Roll – bestimmt bei der Wiedergabe oder 
Aufnahme den Umfang der Audiodaten, die vor der 
Position des Wiedergabe-Cursors (Timeline) oder 
des Wiedergabestart-Markers bzw. vor dem Start 
der Timeline-Selektion abgespielt werden soll. 

Um die Wiedergabe mit halber 
Geschwindigkeit zu starten, können Sie auch 
die Tastenkombination Umschalt + Leer 
(Windows oder Mac) drücken oder bei 
gedrückter Umschalttaste auf die 
Play-Schaltfläche klicken (Mac).

Weitere Informationen zur Loop-Wiedergabe 
und zum Dynamic Transport-Modus finden Sie 
unter „Loop Playback-Modus“ auf Seite 418.

Sie können die Aufnahme auch sofort starten, 
indem Sie F12, Strg + Leer (Windows) bzw. 
Befehl + Leer (Mac) oder indem Sie die Taste 3 
drücken, während sich der Ziffernblock im 
Transport-Modus befindet.

Um die Aufnahme bei halber 
Geschwindigkeit zu starten, drücken Sie 
Strg + Umschalt + Leer (Windows) oder 
Befehl + Umschalt + Leer (Mac).
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Pre-Roll ist besonders hilfreich für Punch-
Aufnahmen, denn so haben Sie Zeit, sich einzuhören 
und ein Gefühl für den Beat zu bekommen, bevor 
der Punch-In-Punkt erreicht wird. Geben Sie einen 
neuen Wert im entsprechenden Feld ein, um die 
Länge des Pre-Roll-Bereichs einzustellen, oder 
ziehen Sie die Pre-Roll-Markierung in der Haupt-
Zeitbasis-Leiste an eine neue Position.

Post-Roll – bestimmt bei der Wiedergabe oder 
Aufnahme die Zeitspanne, die nach dem Ende der 
Timeline-Selektion weitergespielt werden soll. Post-
Roll ist hilfreich bei Punch-Aufnahmen, denn die 
Wiedergabe wird nach dem Punch-Out-Punkt nicht 
unterbrochen. So können Sie prüfen, ob der Übergang 
zum vorher aufgezeichneten Material fließend ist. 
Geben Sie einen neuen Wert im entsprechenden 
Feld ein, um die Länge des Post-Roll-Bereichs 
festzulegen, oder ziehen Sie das Post-Roll-Flag in der 
Haupt-Zeitbasis-Leiste an eine neue Position.

Start – legt den Beginn eines Wiedergabe- oder 
Aufnahmebereichs fest. Sie können den Startpunkt 
festlegen, indem Sie einen neuen Positionswert im 
entsprechenden Feld eingeben oder die 
entsprechende Timeline-Selektion oder den 
entsprechenden Wiedergabestart-Marker in der 
Haupt-Zeitbasis-Leiste verschieben. Weitere 
Informationen finden Sie unter „Timeline-
Selektionsmarker“ auf Seite 460.

End – legt den Endpunkt eines Wiedergabe- oder 
Aufnahmebereichs fest. Sie können den Endpunkt 
festlegen, indem Sie einen neuen Positionswert im 
entsprechenden Feld eingeben oder die 
entsprechende Timeline-Selektion in der Haupt-
Zeitbasis-Leiste verschieben. Weitere 
Informationen finden Sie unter „Timeline-
Selektionsmarker“ auf Seite 460.

Length – legt die Länge des Wiedergabe- oder 
Aufnahmebereichs fest. Sie können die Länge 
festlegen, indem Sie einen neuen Positionswert im 
entsprechenden Feld eingeben oder einen Bereich in 
einer beliebigen Zeitbasis-Leiste auswählen.

MIDI-Steuerelemente

Zur Anzeige der MIDI-Steuerelemente im Transport 
wählen Sie eine der folgenden Möglichkeiten:

 Wählen Sie View > Transport > MIDI Controls.

 Klicken Sie im Transport-Fenster bei 
gedrückter Strg-Taste (Windows) oder 
Befehlstaste (Mac) auf die Schaltfläche „+“, um 
die MIDI-Steuerelemente anzuzeigen.

Wenn die Edit- und Timeline-Selektionen 
gekoppelt sind, können Sie in der Playlist 
einer Spur eine Edit-Selektion vornehmen, 
um den Wiedergabe- und Aufnahmebereich 
festzulegen. Siehe „Koppeln und Entkoppeln 
von Timeline- und Edit-Selektionen“ auf 
Seite 575.

Transport-Fenster, MIDI-Steuerelemente

Schaltfläche „+“, Transport-Fenster mit 
MIDI-Steuerelementen

Tempo Ruler 
Enable

Auf Note warten

Count Off Pegelanzeige

Metronom-Schaltfläche

MIDI Merge

Tempo

Popup-Menü für Tempo-Auflösung (Beat-Wert)
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Auf Note warten – wenn diese Schaltfläche aktiviert 
ist, wird mit der Aufnahme erst bei Empfang von 
MIDI-Signalen begonnen. Dadurch wird 
gewährleistet, dass die Aufnahme erst dann beginnt, 
wenn Sie zur MIDI-Eingabe bereit sind. Die erste Note 
(oder andere MIDI-Daten) wird dann genau am 
Anfang des Aufnahmebereichs aufgezeichnet.

Metronom-Schaltfläche – wenn aktiviert, generiert 
Pro Tools einen Metronom-Impuls, der bei 
Wiedergabe oder Aufnahme entweder eingebaute 
Sounds oder MIDI-Instrumente auslösen kann.

Das Pro Tools-Metronom wird im Dialogfeld 
„Click/Countoff-Options“ konfiguriert. 
Doppelklicken Sie auf die Metronom-Schaltfläche, 
um dieses Dialogfeld zu öffnen.

Vorzählen – wenn diese Schaltfläche aktiviert ist, 
zählt Pro Tools die (in der Schaltfläche) angegebene 
Anzahl von Einheiten vor, bevor mit der Aufnahme 
oder Wiedergabe begonnen wird.

Doppelklicken Sie auf die Count Off-Schaltfläche, um 
das Click/Count Off Options-Dialogfeld zu öffnen.

MIDI Merge – wenn „MIDI-Merge“ aktiviert ist 
(Merge-Modus), werden neu aufgenommene 
MIDI-Daten mit dem bereits bestehenden 
Spurmaterial zusammengeführt. Wenn die 
Schaltfläche nicht aktiviert ist (Replace-Modus), 
wird vorhandenes Spurmaterial durch die 
aufgezeichneten MIDI-Daten ersetzt.

Tempo Ruler Enable (Dirigent) – wenn diese 
Schaltfläche aktiviert ist, verwendet Pro Tools die 
auf der Tempo-Leiste festgelegten Tempo-
Informationen (die sogenannte Tempo-Map). 
Wenn sie nicht aktiviert ist, wechselt Pro Tools in 
den Manual Tempo-Modus und ignoriert die 
Tempo-Leiste.

Im Manual Tempo-Modus können Sie einen BPM-
Wert in das Tempo-Feld eingeben oder aber das 
Tempo durch Drücken der Taste „T“ auf der 
alphanumerischen Tastatur klopfen.

Aktuelle Taktart – zeigt die aktuelle Taktart der 
Session an der jeweiligen Wiedergabeposition an. 
Doppelklicken Sie auf die Anzeige für die aktuelle 
Taktart (Current Meter), um das Change Meter-
Fenster zu öffnen.

Aktuelles Tempo – zeigt das aktuelle Tempo der 
Session an der jeweiligen Wiedergabeposition an. 
Im Manual Tempo-Modus können Sie einen BPM-
Wert in dieses Feld eingeben oder aber ein Tempo 
manuell über eine Computertastatur oder eine 
externe MIDI-Tastatur klopfen.

Sie können F11 drücken, um den Wait for 
Note-Modus zu aktivieren (wenn in den 
MIDI-Voreinstellungen nicht die Disable 
F11 for Wait for Note-Option aktiviert ist).

Auf dem Mac wird derselbe Tastaturbefehl 
wie in Pro Tools für die Wait for Note-Option 
verwendet (F11). Um F11 für die Wait for 
Note-Option in Pro Tools zu verwenden, 
müssen Sie darauf achten, dass der 
Tastaturbefehl in den Apple 
Systemeinstellungen deaktiviert ist.

Wenn sich der Ziffernblock im Transport-
Modus befindet, können Sie die Metronom-
Funktion mit der Taste 7 aktivieren.

Wenn sich der Ziffernblock im Transport-
Modus befindet, können Sie die Count Off-
Funktion mit der Taste 8 aktivieren.

Wenn sich der Ziffernblock im Transport-
Modus befindet, können Sie den MIDI 
Merge-Modus mit der Taste 9 aktivieren.
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Output-Anzeige
Pro Tools bietet Ausgangsanzeigen im Transport-
Fenster. Hier werden die Monitoring-Pegel für die 
Signale angezeigt, die entweder an physische 
Ausgänge aus der Session auf Ihren Audio-
Interfaces oder an interne Busse in der Session 
weitergeleitet werden. Die oberste LED leuchtet 
rot und zeigt das Clipping bei den D/A-Wandlern 
Ihres Audio-Interface für die jeweiligen Kanäle 
oder internen Busse an. 

Fenster im MIDI Editor
In den MIDI Editor-Fenstern können Sie MIDI-
Noten sowie Controller-Daten anzeigen und 
bearbeiten. Sie können mehrere MIDI Editor-Fenster 
öffnen, um an verschiedenen Teilen Ihrer MIDI-
Arrangements gesondert zu arbeiten. In den MIDI 
Editor-Fenstern werden Instrumenten- und MIDI-
Spurdaten in der Notendarstellung überkopiert oder 
auf separaten Spuren in der Notationsdarstellung 
dargestellt. Sie können MIDI-Controller-Daten wie 
Velocity, Tonhöhenbeugung (Pitch Bend) und 
Modulationrad in Controller-Lanes unterhalb des 
Notes-Fensterbereichs anzeigen und bearbeiten.

Anzeigen des MIDI Editors 
im Edit-Fenster
Sie haben die Möglichkeit, am unteren Rand des 
Edit-Fensters (unter dem Tracks-Fensterbereich) 
einen MIDI Editor-Fensterbereich einzublenden 
(oder auszublenden). 

Führen Sie einen der folgenden Schritte aus, 
um das MIDI Editor-Bedienfeld im Edit-Fenster 
einzublenden (oder auszublenden):

 Aktivieren (oder deaktivieren) Sie View > Other 
Displays > MIDI Editor.

 Klicken Sie im Tracks-Fensterbereich des Edit-
Fensters auf das MIDI Editor Show/Hide-
Symbol links unten.

 Doppelklicken Sie unter dem Tracks-
Fensterbereich des Edit-Fensters auf 
die Trennlinie.

 Aktivieren (oder deaktivieren) Sie im Menü des 
Edit-Fensters MIDI Editor.

Noten-Editor-Fenster
Im Score Editor-Fenster können Sie Instrumenten- 
und MIDI-Spuren in Notenschrift anzeigen und 
bearbeiten. Die MIDI-Performances werden 
automatisch in Echtzeit transkribiert. Sie können 
einen Score Ihrer Session oder nur Teile aus 
einzelnen Spuren drucken.

Ausgangsanzeigen im Transport-Fenster

Weitere Informationen finden Sie unter 
„Ausgangsanzeigen“ auf Seite 1013.

Weitere Informationen finden Sie unter 
Kapitel 32: „MIDI-Editoren“.

Weitere Informationen finden Sie unter 
Kapitel 33: „Score Editor“.
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Workspace-Browser
Pro Tools kann Ihre Session bzw. Mediendateien und -
verzeichnisse mithilfe von Workspace-Browsern in 
Datenbanken speichern. Browser bieten in Pro Tools 
eine intuitive Benutzeroberfläche, um schnell auf 
Online- und Offline-Mediendateien und -Sessions 
zugreifen zu können.

Die Browser in Pro Tools entsprechen den Fenstern 
des Betriebssystems auf Ihrem Computer (wie 
Windows Explorer oder Mac Finder), sind jedoch 
speziell für den Arbeitsablauf mit Pro Tools 
konzipiert. Mehrere Browser können gleichzeitig 
angezeigt werden, wobei ihre Anzeigeeinstellungen 
unabhängig voneinander festgelegt werden können.

In einem Browser können Sie Audiodateien, 
Videodateien und Sessions suchen und sortieren. 
Diese Dateien werden im Browser angezeigt und 
können direkt in die aktuelle Pro Tools-Session 
gezogen und dort abgelegt werden.

Wenn Offline-Elemente benötigt werden, können Sie 
die entsprechenden Dateien mit Pro Tools suchen und 
erneut mit den Online-Medien koppeln. 

Zu den wichtigsten Elementen im Workspace-
Browser (siehe Abbildung unten) gehören: 

Anzeigevoreinstellungen – ermöglichen die 
Speicherung von bis zu 5 verschiedenen Browser-
Anzeigen. 

Abhör-Steuerelemente – bieten Tools zum 
Abhören von Audiodateien im Browser. 

Suchfunktionen – ermöglichen die Suche nach 
Dateien und Ordnern in Ihrem System anhand von 
einfachen oder erweiterten Suchkriterien. 

Browser-Menü – enthält Befehle 
zur Dateiverwaltung. 

Spaltenüberschriften – geben den Typ von 
Metadaten an, die in der Elementliste angezeigt 
werden. Für Spaltenüberschriften können Sie 
folgende Aktionen durchführen:

• Sie können durch Ziehen der Spaltenränder bzw. 
-kopfzeilen Position bzw. Breite der Spalten 
ändern.

• Sie können Spalten in den festen oder den 
verstellbaren Fensterbereich ziehen.

Locations-Bereich – bietet eine Anzeige von 
Volumes (sowie Ordnern und Dateien), Katalogen 
und der derzeit geöffneten Session für Ihr System. 

Browser-Bereich – bietet eine Anzeige der 
Elemente in Ihrem System, die in dem unter 
Locations-Bereich ausgewählten Volume (oder 
Ordner), Katalog bzw. der geöffneten Session 
enthalten sind. Alternativ werden die 
Suchergebnisse im Browser-Bereich angezeigt.

Drücken Sie Wahl + ; (Mac) bzw. Alt + ; 
(Windows), um den Workspace-Browser 
zu öffnen. 

Um alle Browser in den Vordergrund zu 
verschieben, drücken Sie Wahl + J (Mac) 
bzw. Alt + J (Windows).

Um alle Browser in den Hintergrund zu 
verschieben, drücken Sie Wahl + Umschalt + J 
(Mac) bzw. Alt + Umschalt + J (Windows). Ausführliche Informationen zu Workspace-

Browsern finden Sie unter Kapitel 16: 
„Workspace-Browser“.
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Task Manager-Fenster
Das Task Manager-Fenster dient zum Anzeigen und 
Verwalten aller Hintergrundvorgänge, die in 
Pro Tools gestartet werden können. Über das Tasks-
Fenster können Sie Hintergrundfunktionen wie 
beispielsweise das Kopieren von Dateien, das 
Ausführen von Suchfunktionen, das Erstellen eines 
Indexes oder eines Fades überwachen, unterbrechen 
oder abbrechen.

Webbrowser-Funktion 
innerhalb der Anwendung
Pro Tools bietet über zwei neue Webbrowser 
innerhalb der Anwendung den einfachen Zugriff auf 
den Avid Store, die Pro Tools-Webhilfe, das Avid 
Support Center sowie andere Online-Ressourcen. 

Avid Marketplace – bietet eine sichere 
Internetverbindung zu Avids Webshop-
Ressourcen für Pro Tools.

Pro Tools Online – bietet den einfachen Zugriff auf 
die webbasierte Pro Tools-Hilfe, die Knowledge 
Base sowie Avids Audio-Community-Foren.

Wählen Sie im Marketplace-Menü eine der folgenden 
Optionen, um den in Pro Tools integrierten 
E-Commerce-Webbrowser zu starten:

• Ihr Konto

• Plug-Ins

• Support Center

• Upgrades

Wählen Sie im Hilfemenü eine der folgenden 
Optionen, um den in Pro Tools integrierten 
Webbrowser für Online-Ressourcen zu starten:

• Pro Tools-Hilfe 

• Pro Tools Knowledge Base 

• Avid-Audio-Foren 

• Avid Support Center

Ausführliche Informationen zum Tasks-
Fenster finden Sie unter „Task Manager-
Fenster“ auf Seite 321.
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Navigation im integrierten 
Pro Tools-Webbrowser
Der in Pro Tools integrierte Webbrowser ist über 
die Webbrowser-Leiste auf einfache Weise 
zu bedienen.

Zurück – mit Hilfe dieser Schaltfläche gehen Sie 
zurück zur zuvor betrachteten Webseite.

Vorwärts – mit dieser Schaltfläche gehen Sie 
vorwärts zur nächsten Seite.

Zur Startseite – diese Schaltfläche bringt Sie zur 
Startseite der derzeit ausgewählten Website.

Aktualisieren – lädt die aktuell im Browser 
angezeigte Seite erneut.

Websites – indem Sie auf eine dieser 
Schaltflächen klicken, gelangen Sie zur Startseite 
der jeweiligen Avid-Website. Die Browser Avid 
Marketplace und Pro Tools Online verfügen über 
verschiedene Websites.

Öffnen eines externen Webbrowsers

Sie können die aktuelle Webseite im Standard-
Webbrowser Ihres Betriebssystems öffnen.

So öffnen Sie die aktuelle Webseite in einem 
externen Browser:

 Klicken Sie im integrierten Webbrowser 
(Avid Marketplace oder Pro Tools Online) 
rechts in der Leiste auf die Schaltfläche mit dem 
Fenstersymbol, um einen externen Webbrowser 
zu öffnen.

Avid Marketplace
Das Marketplace-Menü in Pro Tools bietet Ihnen 
den einfachen Zugang zu Ihrem Avid-Konto und 
zum Online-Shop von Avid, in dem Sie Plug-Ins, 
Upgrades oder Avid-Support kaufen können. 

So melden Sie sich bei Ihrem Avid-Konto an:

 Wählen Sie Marketplace > Your Account.

So gelangen Sie zum Avid Store für Plug-Ins:

 Wählen Sie Marketplace > Plug-Ins.

So gelangen Sie zum Avid Store für Support 
und Training:

 Wählen Sie Marketplace > Support Center.

 Wählen Sie Help > Avid Support and Training.

So gelangen Sie zum Avid Store für Software-
Upgrades:

 Wählen Sie Marketplace > Upgrades.

Pro Tools-Webbrowser

Zurück
Vorwärts

Zur Startseite
Aktualisieren

Websites

Symbol für externen Webbrowser

Sie erreichen den Avid Store auch über das 
AudioSuite-Menü und über den Spur-Insert-
Selektor von Plug-Ins, wo Sie die 
Avid Marketplace-Option auswählen.
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Pro Tools Online
Zusätzlich zu den lokal mit Pro Tools installierten 
Ressourcen gewährt Ihnen das Hilfemenü 
einfachen Zugriff auf den Pro Tools-Webbrowser.

So greifen Sie über das Hilfemenü auf Pro Tools-
Online-Ressourcen zu:

 Wählen Sie Help und eine der 
folgenden Optionen:

• Pro Tools Help 

• Pro Tools Knowledge Base 

• Avid Audio Forums 

Pro Tools-Help

Der Menübefehl Pro Tools Help bringt Sie zur 
webbasierten Pro Tools-Hilfe im Pro Tools-
Webbrowser. So greifen Sie immer auf die 
aktuellsten Pro Tools-Hilfedateien zu, sobald 
diese verfügbar sind. Wenn die Pro Tools-
Hilfedateien übersetzt wurden, haben Sie auch 
darauf Zugriff.

Wenn Sie nicht über eine Internetverbindung 
verfügen, öffnet Pro Tools automatisch die lokalen 
englischen Hilfedateien, die gemeinsam mit 
Pro Tools installiert wurden.

Pro Tools Knowledge Base

Der Menübefehl Pro Tools Knowledge Base führt 
Sie über den in Pro Tools neu integrierten 
Webbrowser zur Avid Knowledge Base. In der 
Avid Knowledge Base finden Sie ausführliche 
Informationen zur Fehlerbehandlung in Pro Tools 
(einschließlich Kompatibilitätsinformationen und 
Software-Updates).

Avid Audio Forums

Der Menübefehl Avid Audio Forums bringt Sie über 
den in Pro Tools neu integrierten Webbrowser zu den 
Audio-Foren von Avid. In einem Avid-Audio-Forum 
treffen Sie auf eine breit gefächerte Nutzer-
Community und können sich mit anderen Pro Tools-
Anwendern austauschen.

Avid Support Center

Der Menübefehl Avid Support Center bringt Sie über 
den in Pro Tools neu integrierten Webbrowser zum 
Online Support Center von Avid. Im Avid Support 
Center erhalten Sie Supportinformationen zu Ihren 
Avid-Produkten.

Suche nach Updates

So suchen Sie nach den neuesten Updates für die 
Pro Tools-Software, Hardware-Treiber und Plug-Ins:

 Wählen Sie Help > Check For Updates.
Auf die Pro Tools-Onlinehilfe können Sie 
auch über Safari oder Internet Explorer 
zugreifen. Das ist hilfreich, wenn Pro Tools 
gerade nicht läuft oder wenn Sie die 
Hilfeversion oder -sprache ändern möchten. 
Weitere Informationen finden Sie unter 
http://www.avid.com/ProToolsHelp.

http://www.avid.com/ProToolsHelp
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Verwalten von Fenstern

Fensterkonfigurationen
Pro Tools liefert ein leistungsstarkes Mittel zur 
Verwaltung der Konfiguration von Fenstern in 
Ihrer Session sowie für die interne Konfiguration der 
Edit-, Mix-, MIDI Editor-, Score Editor- und 
Transport-Fenster. Mit der Fensterkonfigurationsliste 
können Sie Fensterkonfigurationen erstellen (oder 
löschen) und gespeicherte Fensterkonfigurationen 
verwalten. In Pro Tools können Sie bis zu 
99 Fensterkonfigurationen speichern. 
Die Fensterkonfigurationen werden mit der Session 
abgespeichert.

Erstellen neuer 
Fensterkonfigurationen

So erstellen Sie eine neue Fensterkonfiguration:

1 Öffnen Sie die Fenster, die Sie in die 
Fensterkonfiguration einschließen möchten, 
und positionieren Sie diese an der Stelle, an der 
sie auf dem Bildschirm erscheinen sollen.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Window > Configurations > New 

Configuration. 

• Wenn die Fensterkonfigurationsliste geöffnet 
ist, wählen Sie New Configuration aus dem 
Window Configuration List-Popup-Menü.

3 Wählen Sie im New Window Configuration-
Dialogfeld eine der folgenden Möglichkeiten:

• Wählen Sie Window Layout und legen Sie fest, 
ob Anzeigeeinstellungen für die Edit-, Mix-, 
Targeted MIDI Editor-, Score Editor- und 
Transport-Fenster eingeschlossen werden sollen.

• Wählen Sie eine Option für die 
Fensteranzeigeeinstellungen im Popup-Menü 
(Edit Window, Mix Window, MIDI Editor 

(Targeted), Score Editor Window oder Transport 

Window).

4 Benennen Sie die Fensterkonfiguration.

5 Sie können für die neue Fensterkonfiguration 
eine andere Nummer eingeben. Wenn die 
Nummer, die Sie eingeben, bereits von einer 
anderen Fensterkonfiguration verwendet wird, 
werden Sie aufgefordert, diese zu ersetzen oder 
den Vorgang abzubrechen (Cancel). 
Andernfalls setzt Pro Tools automatisch die 
erste verfügbare Nummer (1–99) für die 
Fensterkonfiguration ein. 

Erstellen Sie eine Session-Vorlage mit Ihren 
bevorzugten Fensterkonfigurationen. 
Sie können anschließend die Vorlage 
verwenden, wenn Sie eine neue Session starten, 
oder den Import Session Data-Befehl 
verwenden, um Fensterkonfigurationen in Ihre 
aktuelle Session zu importieren.

New Window Configuration-Dialogfeld
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6 Geben Sie gegebenenfalls eine Anmerkung zu 
der neuen Fensterkonfiguration ein.

7 Klicken Sie auf OK, um die neue 
Fensterkonfiguration zu speichern, oder wählen 
Sie Cancel.

Die neue Fensterkonfiguration wird zur 
Fensterkonfigurationsliste hinzugefügt.

So erstellen Sie eine neue Fensterkonfiguration an 
einer bestimmten Steckplatznummer:

 Drücken Sie auf dem Ziffernblock Punkt (.), 
eine Zahl (1–99), und dann Plus (+), um eine 
neue Fensterkonfiguration an dieser 
Steckplatznummer einzufügen. 

Abrufen von 
Fensterkonfigurationen
Sie können die Fensterkonfigurationsliste 
verwenden, um gespeicherte Fensterkonfigurationen 
abzurufen. Auch über den Ziffernblock auf der 
Computertastatur können Sie eine bestimmte 
Fensterkonfiguration abrufen.

Sie haben folgende Möglichkeiten, um eine 
Fensterkonfiguration abzurufen:

 Wählen Sie die Fensterkonfiguration über 
Window > Configurations.

 Klicken Sie in der Fensterkonfigurationsliste 
auf die gewünschte Fensterkonfiguration, 
um diese abzurufen.

 Drücken Sie auf dem Ziffernblock Punkt (.), die 
Nummer der Fensterkonfiguration (1–99) und 
dann Sternchen (*).

Die Bildschirmanordnung der 
Pro Tools-Session wird mit der gespeicherten 
Fensterkonfiguration aktualisiert.

Rückgängigmachen von 
Fensterkonfigurationen
In Pro Tools können Sie mit einem einzigen 
Rückgängigmachen-Schritt zur vorherigen 
Fensteranordnung und den vorherigen 
Fenstereinstellungen zurückkehren. Dies ist 
nützlich, wenn Sie beispielsweise eine 
Fensterkonfiguration abrufen, aber dann 
entscheiden, dass Sie zum vorherigen 
Fensterzustand zurückkehren möchten.

So machen Sie eine Fensterkonfiguration rückgängig:

 Drücken Sie auf dem Ziffernblock Punkt (.) und 
dann Sternchen (*). 

So stellen Sie eine Fensterkonfiguration wieder her:

 Drücken Sie auf dem Ziffernblock Punkt (.) und 
dann Sternchen (*).

Wenn die Auto-Update Active Configuration-
Option aktiviert ist, kehren Sie durch das 
Rückgängigmachen der Fensterkonfiguration zur 
vorherigen gespeicherten Fensterkonfiguration 
zurück, ohne die Änderungen automatisch zu 
speichern (siehe „Aktualisieren von 
Fensterkonfigurationen“ auf Seite 191).

Bearbeiten von 
Fensterkonfigurationen
Sie können die Eigenschaften ändern, die mit den 
Fensterkonfigurationen gespeichert sind, ebenso 
wie die Nummer, den Namen oder Anmerkungen. 

So bearbeiten Sie eine Fensterkonfiguration:

1 Wählen Sie in der Fensterkonfigurationsliste 
die Fensterkonfiguration aus, die Sie bearbeiten 
möchten.

Wenn eine Fensterkonfiguration an dieser 
Steckplatznummer bereits vorhanden ist, 
wird diese durch die neue 
Fensterkonfiguration überschrieben.
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2 Wählen Sie im Window Configuration List-
Popup-Menü Edit <Name>. 

3 Bearbeiten Sie die Konfiguration im Edit 
Window Configuration-Dialogfenster und 
klicken Sie auf OK.

Aktualisieren von 
Fensterkonfigurationen
Nachdem Sie eine gespeicherte 
Fensterkonfiguration abgerufen haben, können Sie 
Änderungen am Fensterlayout und den 
Fenstereinstellungen vornehmen und anschließend 
die gespeicherte Fensterkonfiguration mit Ihren 
Änderungen aktualisieren. Dies können Sie 
manuell vornehmen oder die aktive Konfiguration 
in Pro Tools automatisch aktualisieren.

Sie haben folgende Möglichkeiten, um eine 
Fensterkonfiguration manuell zu aktualisieren:

 Wählen Sie Window > Configurations > Update 

Active Configuration. Die aktive 
Fensterkonfiguration wird aktualisiert und 
enthält nun alle Änderungen an den 
eingeschlossenen Eigenschaften 
(Fensteranordnung und 
Fensteranzeigeeinstellungen).

 Wählen Sie im Window Configuration List-
Popup-Menü Update <Name>. 
Die ausgewählte Fensterkonfiguration wird mit 
allen Änderungen an den eingeschlossenen 
Eigenschaften aktualisiert.

Sie haben folgende Möglichkeiten, um die aktive 
Konfiguration in Pro Tools automatisch 
zu aktualisieren:

 Wählen Sie Window > Configurations > Auto-

Update Active Configuration.

 Wählen Sie im Window Configuration List-
Popup-Menü die Auto-Update Active 

Configuration-Option.

Wenn die Auto-Update Active Configuration-

Option aktiviert ist, wird die aktive 
Fensterkonfiguration bei jeder Änderung an der 
Fensteranordnung und den 
Fensteranzeigeeinstellungen aktualisiert.

Fensterkonfigurationen, die keine 
Fensteranordnung umfassen und nur 
Fensteranzeigeeinstellungen enthalten, können 
nicht zu einer aktiven Fensterkonfiguration 
gemacht und somit nicht automatisch aktualisiert 
werden. Wenn Sie eine Fensterkonfiguration mit 
Änderungen an den Fensteranzeigeeinstellungen 
aktualisieren möchten (beispielsweise die Breite 
der Clipliste im Edit-Fenster), verwenden Sie den 
Update-Befehl in der Fensterkonfigurationsliste.

Zurücksetzen von 
Fensterkonfigurationen
Durch das Zurücksetzen einer Fensterkonfiguration 
wird diese zusammen mit der ihr zugeordneten 
Steckplatznummer entfernt. Die Steckplatznummern 
der anderen Fensterkonfigurationen werden dadurch 
nicht geändert. Der Clear-Befehl ist nützlich, wenn Sie 
eine andere Konfiguration in denselben Steckplatz 
einfügen möchten. 

So setzen Sie eine Fensterkonfiguration zurück:

1 Wählen Sie in der Fensterkonfigurationsliste 
die Fensterkonfiguration aus, die Sie 
zurücksetzen möchten.

2 Wählen Sie im Window Configuration List-
Popup-Menü Clear <Name>. 

Löschen von 
Fensterkonfigurationen
Durch das Löschen einer Fensterkonfiguration 
wird diese zusammen mit der ihr zugeordneten 
Steckplatznummer entfernt. Die nachfolgenden 
Fensterkonfigurationen werden neu nummeriert.
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So löschen Sie eine Fensterkonfiguration:

1 Wählen Sie in der Fensterkonfigurationsliste 
die Fensterkonfiguration aus, die Sie 
löschen möchten.

2 Wählen Sie im Window Configuration List-
Popup-Menü Delete <Name>. 

So löschen Sie alle Fensterkonfigurationen:

 Wählen Sie im Window Configuration List-
Popup-Menü Delete All.

Importieren von 
Fensterkonfigurationen
Sie können Fensterkonfigurationen mit dem 
Import Session Data-Befehl aus einer anderen 
Session importieren. 

So importieren Sie Fensterkonfigurationen:

1 Wählen Sie File > Import Session Data.

2 Wählen Sie die Window Configurations-Option.

3 Wenn Sie nur Fensterkonfigurationen 
importieren möchten, klicken Sie in das 
Session Data to Import-Popup-Menü und 
wählen Sie None.

4 Klicken Sie auf OK.

Anordnen von Fenstern
Pro Tools bietet Befehle, mit denen alle geöffneten 
Fenster nebeneinander oder hintereinander 
angeordnet werden können. Unverankerte Fenster 
(wie Plug-In-Fenster) und das Transport-Fenster 
bleiben bei diesen Befehlen unberücksichtigt.

So ordnen Sie Fenster an:

 Wählen Sie Window > Arrange und 
anschließend eine der folgenden Optionen:

Tile – ordnet alle geöffneten Fenster kachelförmig 
auf dem Bildschirm an.

Tile Horizontal – ordnet alle geöffneten Fenster als 
horizontal ausgerichtete Kacheln auf dem 
Bildschirm an. Bei zu vielen geöffneten Fenstern 
ist diese Option nicht verfügbar.

Tile Vertical – ordnet alle geöffneten Fenster als 
vertikal ausgerichtete Kacheln nebeneinander auf 
dem Bildschirm an. Bei zu vielen geöffneten 
Fenstern ist diese Option nicht verfügbar.

Cascade – ordnet alle geöffneten Fenster 
hintereinander auf dem Bildschirm an.

Ausblenden aller 
unverankerten Fenster
Mit dem Hide All Floating Windows-Befehl können 
Sie alle unverankerten Fenster aus- oder 
einblenden. Dies ist nützlich, um rasch alle 
unverankerten Fenster zu entfernen, damit Sie im 
Edit- oder im Mix-Fenster arbeiten können. 

So blenden Sie alle unverankerten Fenster ein 
oder aus:

 Wählen Sie Window > Hide All Floating 

Windows.

Drücken Sie Strg + Alt + Windows + W 
(Windows) bzw. Befehl + Wahl + Ctrl + W 
(Mac), um alle unverankerten Fenster ein- 
bzw. auszublenden.
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Schließen von Fenstern

So schließen Sie ein geöffnetes Fenster: 

1 Achten Sie darauf, dass das zu schließende 
Fenster im Vordergrund angezeigt wird.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Schließen-Schaltfläche für 
das Fenster. 

• Wählen Sie Window > Close Window.

Funktionsweise der 
Fensterkonfigurationen
In einer Fensterkonfiguration können die Position 
und Größe aller geöffneten Fenster gespeichert 
werden, mit den folgenden Fenstern:

• Edit-Fenster

• Mix-Fenster

• Als Ziel ausgewähltes MIDI Editor-Fenster

• Score Editor-Fenster

• Workspace-Browser

• Session-Setup-Fenster

• Time, Tempo und Event Operations-Fenster

• MIDI Event List

• Real-time MIDI Properties-Fenster

• Beat Detective-Fenster

• Plug-In-Fenster

• Panner-Fenster

• Mic Pre-Fenster

• Alle unverankerten Fenster, die im Window-
Menü aufgeführt sind:

• Task Manager-Fenster

• Transport-Fenster

• Big Counter-Fenster

• Automation-Fenster

• Memory Locations-Fenster

• Machine Track Arming-Fenster

• Video Universe-Fenster

• Videofenster

• Farbpalette

• Undo History-Fenster

• Disk Usage-Fenster

• System Usage-Fenster

Drücken Sie Strg + W (Windows) 
bzw. Befehl + W (Mac), um die 
vordersten Fenster zu schließen.

Die Position und Größe der 
Fensterkonfigurationsliste wird nicht 
zusammen mit den 
Fensterkonfigurationen gespeichert.
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Mit einer Fensterkonfiguration können auch die 
Einstellungen für die Fensteranzeige für die Edit-, 
Mix-, Ziel-MIDI Editor-, Score Editor- und 
Transport-Fenster gespeichert werden.

Fensterkonfigurationsliste
Über die Fensterkonfigurationsliste können 
Sie gespeicherte Fensterkonfigurationen 
abrufen und verwalten oder neue 
Fensterkonfigurationen erstellen.

So öffnen Sie die Fensterkonfigurationsliste:

 Wählen Sie Window > Configurations > Window 

Configuration List.

Eigenschaften von 
Fensterkonfigurationen
Fensterkonfigurationen können zusammen mit 
dem Layout der Fenster in Ihrer Pro Tools-Session 
gespeichert oder abgerufen werden, ebenso wie 
mit den Einstellungen für die Edit-, Mix- und 
Transport-Fenster. Sie können im New Window 
Configuration-Dialogfeld oder im Edit Window 
Configuration-Dialogfeld festlegen, welche dieser 
Eigenschaften für jede Fensterkonfiguration 
gespeichert werden sollen.

Number – ist die Nummer des Steckplatzes, 
in dem die Fensterkonfiguration gespeichert wird 
(1–99). Sie können auf dem Ziffernblock Ihrer 
Computertastatur die Taste Punkt (.), die Nummer 
der Fensterkonfiguration und dann die Taste 
Sternchen (*) drücken, um die 
Fensterkonfiguration abzurufen, die in diesem 
Steckplatz gespeichert ist.

Fensterkonfigurationsliste

Drücken Sie Befehl + Wahl + J (Mac) 
oder Strg + Alt + J (Windows), 
um die Fensterkonfigurationsliste ein- bzw. 
auszublenden.

Edit Window Configuration-Dialogfeld
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Name – ist der Name der gespeicherten 
Fensterkonfiguration.

Fenster-Layout – wenn aktiviert, werden die 
Größe und Position aller geöffneten 
Fenster gespeichert.

Include Edit, Mix, Targeted MIDI Editor, Score 
Editor, and Transport Display Settings – wenn 
aktiviert, werden alle Einstellungen für die 
Anzeige der Edit-, Mix-, Ziel-MIDI Editor-, Score 
Editor- und Transport-Fenster zusammen mit der 
Fensterkonfiguration gespeichert (beispielsweise, 
ob die Clipliste im Edit-Fenster angezeigt wird 
oder nicht). Diese Einstellung ist nur verfügbar, 
wenn die Window Layout-Option aktiviert ist.

Window Display Settings – speichert nur die 
Einstellungen für die Anzeige des ausgewählten 
Fensters (Edit, Mix, Ziel-MIDI Editor, Score 
Editor oder Transport):

• Anzeigeeinstellungen für das Edit-Fenster

• Breite der Tracks-Liste und der Groups-Liste

• Höhe der Tracks-Liste

• Breite der Clipliste

• Welche Leisten angezeigt werden (die 
Hauptleiste wird immer angezeigt) 

• Welche Spurspalten angezeigt werden (etwa 
Inserts, Sends oder Comments)

• Anzeige des Tempo-Editors

• Ob die Transport-Steuerelemente im Edit-
Fenster angezeigt werden

• Anordnung der Symbolleiste des Edit-
Fensters

• Anzeigeeinstellungen für das Mix-Fenster

• Breite der Tracks-Liste und der Groups-Liste

• Höhe der Tracks-Liste

• Welche Spurzeilen angezeigt werden (etwa 
Inserts, Sends oder Comments)

• Schmale/breite Mixer-Ansicht

• Noten-Editor

• MIDI Editor (als Ziel markiert)

• MIDI Editor (nicht als Ziel markiert)

• Anzeigeeinstellungen für das Transport-Fenster

• Zähler-Anzeige

• Anzeige der MIDI-Steuerelemente

• Erweiterte Darstellung

Anmerkungen – hier können Sie Anmerkungen 
zur Fensterkonfiguration eingeben.
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Befehle und Optionen für die 
Fensterkonfiguration
Es sind drei Haupttypen von Befehlen und Optionen 
für die Fensterkonfiguration vorhanden:

• Ansichtsfiltersymbole

• Symbole des Window Configuration List-
Popup-Menüs

• Optionen für die aktive Fensterkonfiguration

Ansichtsfiltersymbole
Mit den Ansichtsfiltersymbolen können Sie in der 
Fensterkonfigurationsliste Fensterkonfigurationen 
ein- oder ausblenden, je nachdem, ob sie zusammen 
mit den Einstellungen für die Fensteranordnung 
(Window Layout), das Edit-Fenster, Mix-Fenster, 
Score Editor-Fenster, MIDI Editor-Fenster oder 
Transport-Fenster gespeichert sind oder nicht.

Führen Sie einen der folgenden Schritte aus, 
um die Fensterkonfigurationen in der 
Fensterkonfigurationsliste ein- oder auszublenden:

 Klicken Sie auf das Ansichtsfiltersymbol, 
um Fensterkonfigurationen ein- oder 
auszublenden, die diese Eigenschaft einschließen 
(Einstellungen für Fensteranordnung, Edit-
Fenster, Mix-Fenster, Score Editor-Fenster, MIDI 
Editor-Fenster oder Transport-Fenster). 

 Wählen (oder deaktivieren) Sie das View Filter-
Element im Window Configuration List-Popup-
Menü.

Window Configuration List-
Popup-Menü
Im Window Configuration List-Popup-Menü können 
Sie bestimmte Darstellungs- und Sortieroptionen 
sowie bestimmte Befehle zum Erzeugen und 
Löschen von Fensterkonfigurationen auswählen.

View Filter – damit können Sie in der 
Fensterkonfigurationsliste Filtersymbole für 
Fensterkonfigurationen ein- oder ausblenden, ebenso 
wie Fensterkonfigurationen mit den Einstellungen 
für die Fensteranordnung, das Edit-Fenster, Mix-
Fenster, Score Editor-Fenster, MIDI Editor-Fenster 
oder Transport-Fenster. 

Ansichtsfiltersymbole für die Fensterkonfigurationsliste

MIDI Editor-Fenster-Einstellungen (als Ziel markiert)

Transport-Fenster-Einstellungen

Score Editor-Fenster-Einstellungen

Mix-Fenster-Einstellungen

Edit-Fenster-Einstellungen

Fenster-Layout

Window Configuration List-Popup-Menü
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Show Comments – hier können Sie Anmerkungen 
zur Fensterkonfigurationsliste eingeben.

New Configuration – erstellt eine neue 
Fensterkonfiguration. Dieser Befehl ist auch über 
Window > Configurations verfügbar.

Update <Name> – aktualisiert die ausgewählte 
Fensterkonfiguration mit allen Änderungen an der 
Anordnung und den Einstellungen der Fenster 
abhängig von den Eigenschaften der 
Fensterkonfiguration. Dieser Befehl ist auch über 
Window > Configurations verfügbar.

Edit <Name> – öffnet das Edit Window 
Configuration-Dialogfeld, in dem Sie die 
Eigenschaften der ausgewählten 
Fensterkonfiguration bearbeiten können.

Clear <Name> – setzt die ausgewählte 
Fensterkonfiguration zurück, ohne den Steckplatz 
(bzw. die Steckplatznummer) zu löschen.

Delete All – löscht alle Fensterkonfigurationen.

Insert Slot Before <Name> – fügt einen neuen 
Steckplatz vor der ausgewählten 
Fensterkonfiguration ein und erhöht, falls 
notwendig, die Nummer jedes nachfolgenden 
Steckplatzes.

Delete <Name> Slot – löscht die ausgewählte 
Fensterkonfiguration und ihren Steckplatz (bzw. 
die Steckplatznummer) und nummeriert jeden 
nachfolgenden Steckplatz neu.

Aktive Konfiguration automatisch aktualisieren 
– aktualisiert automatisch die aktive 
Fensterkonfiguration, während Sie Änderungen an 
der Anordnung und den Einstellungen der Fenster 
vornehmen. Wenn die Auto-Update Active 

Configuration-Option aktiviert ist, wird die 
Nummer der aktiven Konfiguration auch im 
Window-Menü angezeigt. Dieser Befehl ist auch 
über Window > Configurations verfügbar.

Aktive Fensterkonfiguration
Die aktive Fensterkonfiguration wird durch eine 
Raute links neben der Nummer der 
Fensterkonfiguration in der 
Fensterkonfigurationsliste und im Configurations-
Untermenü angezeigt (Window > Configuration). 
Wenn die Auto-Update Active Configuration-
Option aktiviert ist, wird die Nummer der aktiven 
Konfiguration auch im Window-Menü angezeigt. 
Nur Fensterkonfigurationen, die eine 
Fensteranordnung umfassen, können zu einer 
aktiven Fensterkonfiguration gemacht werden. 

Menüs
Die Pro Tools-Menüs enthalten die Befehle und 
Optionen zum Konfigurieren und Arbeiten mit 
Pro Tools, Sessions und Sessions-Materialien.

Pro Tools-Hauptmenüs
Pro Tools enthält die folgenden Hauptmenüs:

File – enthält Befehle zum Erstellen und 
Verwalten von Pro Tools-Sessions.

Edit – enthält Befehle, die zum Bearbeiten und 
Editieren der aktuellen Selektion verwendet 
werden und sich auf die Daten in der Timeline oder 
der Zwischenablage auswirken.

Fensterkonfigurationsliste mit aktiver Konfiguration
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View – enthält Optionen und Befehle 
zur Anpassung der Anzeige in den 
verschiedenen Fenstern. 

Track – enthält Befehle zum Erstellen, Verwalten 
und Bearbeiten von Spuren.

Clip – enthält Befehle zum Verwalten und 
Bearbeiten von Clips.

Event – enthält Befehle zum Bearbeiten von 
Audio- und MIDI-Events.

AudioSuite – enthält AudioSuite-Plug-Ins. 

Options – enthält Befehle zur Auswahl 
verschiedener Bearbeitungs-, Aufnahme-, Abhör-, 
Wiedergabe- und Anzeigeoptionen.

Setup – enthält Befehle zum Öffnen von 
Dialogfeldern und Fenstern sowie zur 
Konfiguration verschiedener Pro Tools-
Hardware- und Softwareparameter.

Window – enthält Befehle zum Anzeigen und 
Ausblenden verschiedener Pro Tools-Fenster.

Marketplace – ermöglicht den Zugriff auf Ihr 
Online-Avid-Konto, den Online-Plug-In-Finder, 
das Online Support Center von Avid und Upgrade-
Optionen für Ihre aktuelle Pro Tools-Version.

Help – ermöglicht den Zugriff auf die 
durchsuchbare Pro Tools-Hilfe, die Pro Tools 

Knowledge Base und die Avid Audio-Foren 
(online). Das Hilfemenü ermöglicht den einfachen 
Zugriff auf die mit Pro Tools installierte PDF-
Dokumentation. 

Das Hilfemenü ermöglicht auch den einfachen 
Zugriff auf das Avid Support Center und den 
Check For Updates-Befehl.

Tracks-, Clip- und Groups-Listen-
Menüs
Diese Menüs enthalten Popup-Menüs, mit deren 
Hilfe Sie die Inhalte der Listen verwalten und 
bearbeiten können:

Menü der Tracks-Liste – enthält Befehle zum Ein- 
und Ausblenden von Spuren in den Mix-, Edit-, 
MIDI Editor- und Score Editor-Fenstern. Über das 
Track List-Popup-Menü können Sie auch den 
Inhalt der Tracks-Liste organisieren. 

Groups-Listen-Menü (Edit-Gruppen und Mix-
Gruppen) – enthält Befehle zum Erstellen, 
Anzeigen, zeitweiligen Deaktivieren und Löschen 
von Mix- und Edit-Gruppen.

Cliplisten-Menü (nur Edit-Fenster) – enthält 
Befehle zum Suchen, Auswählen, Sortieren, 
Leeren, Umbenennen, Stempeln, Komprimieren, 
Exportieren und Neuberechnen von 
Wellenformübersichten in der Clipliste. Über das 
Popup-Menü können Sie sich auch die Reihenfolge 
zum Ablegen der Clips anzeigen, die von der 
Clipliste in die Timeline gezogen werden. 

Kontextmenüs für Spur- und 
Clipnamen
Über den Spurnamen und den Clipnamen haben 
Sie Zugriff auf Kontextmenüs, die durch Klicken 
mit der rechten Maustaste geöffnet werden und mit 
denen Sie Spuren oder Clips verwalten oder 
bearbeiten können:

Weitere Informationen finden Sie unter 
„Tracks-Liste“ auf Seite 232.

Weitere Informationen finden Sie unter „Die 
Groups-Liste“ auf Seite 257

Weitere Informationen finden Sie unter 
Kapitel 15: „Clipliste“.
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Kontextmenü für Spurnamen – wenn Sie im Edit-
Fenster, im Mix-Fenster oder in der Tracks-Liste 
mit der rechten Maustaste auf einen Spurnamen 
klicken, haben Sie Zugriff auf verschiedene Spur-
Befehle (beispielsweise Aus-/Einblenden, 
Aktivieren/Deaktivieren, Umbenennen, Duplizieren 
und Löschen von Spuren). 

Kontextmenü für Clipnamen (nur Edit-Fenster) – 
wenn Sie in der Clipliste mit der rechten Maustaste 
auf einen Clipnamen klicken, erhalten Sie Zugriff 
auf Befehle zum Löschen, Umbenennen, Stempeln 
oder Ersetzen von Clips (nur Pro Tools HD). Sie 
können in dem Popup-Menü auch Clip-
Definitionen oder ausgewählte Clips als Dateien 
exportieren, Wellenformübersichten neu 
berechnen, die übergeordnete Datei im 
Workspace-Browser oder einen Clip als Objekt im 
Edit-Fenster auswählen.

Popup-Menüs für Gruppenname 
und Gruppen-ID-Anzeige einer 
Spur
Wenn Sie in der Groups-Liste auf einen 
Gruppennamen klicken und die Maustaste gedrückt 
halten oder auf eine Gruppen-ID-Anzeige klicken, 
haben Sie über ein Popup-Menü Zugriff auf 
verschiedene Gruppenbefehle (beispielsweise das 
Auswählen von Spuren in einer Gruppe).

QuickInfos
Pro Tools unterstützt Sie in allen Hauptfenstern 
mit QuickInfos. Sobald Sie mit dem Cursor einige 
Sekunden lang auf ein Namenskürzel oder ein 
unbeschriftetes Symbol oder Tool zeigen, 
erscheint ein Text mit dem Namen der Funktion 
oder mit Details (je nachdem, wie die QuickInfos 
eingestellt sind).

So konfigurieren Sie die QuickInfos für Pro Tools:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Display-Registerkarte.

2 Klicken Sie im Basics-Abschnitt auf die 
QuickInfo-Optionen, die Sie anzeigen möchten. 

Funktion – zeigt die Namen verschiedener 
Pro Tools-Elemente an (bestimmte Schaltflächen, 
Anzeigen, Modi, Selektoren und Edit-Tools).

Details – zeigt abgekürzte oder ausgeblendete 
Pro Tools-Namen oder Werte für verschiedene 
Pro Tools-Elemente (etwa Insert-Namen, Gain 
Level, Einstellungen und Routing-Zuweisungen).

3 Klicken Sie auf OK. 

Weitere Informationen finden Sie unter 
„Kontextmenü für Spurnamen“ auf 
Seite 235.

Weitere Informationen finden Sie unter 
Kapitel 15: „Clipliste“.

Weitere Informationen finden Sie unter 
„Popup-Menüs für Gruppennamen und 
Gruppen-ID-Anzeigen“ auf Seite 259.

Um QuickInfos zu deaktivieren, lassen Sie 
beide Optionen deaktiviert.
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Kapitel 13: Spuren

Pro Tools verfügt über mehrere Arten von Spuren 
zum Arbeiten mit Audio, MIDI und Video in 
Pro Tools-Sessions. 

Spurarten
Sie können in einer Pro Tools-Session mit mehreren 
unterschiedlichen Spurarten arbeiten. Diese können 
Audio-, Auxiliary-Eingangs-, Master-Fader-, VCA 
Master- (nur Pro Tools HD), MIDI-, Instrumenten- 
und Videospuren umfassen.

Audio-, Auxiliary-Eingangs-, Master-Fader- und 
VCA Master-Spuren

Pro Tools unterstützt Audiospuren im Mono-, Stereo- 
und Mehrkanalformat, Auxiliary-Eingangs-, Master-
Fader- und VCA Master-Spuren.

Audiospuren. – Audiospuren ermöglichen es, 
auf Festplatte aufzunehmen und aufgenommene 
oder importierte Audiodateien von der Festplatte 
wiederzugeben.

Auxiliary-Eingangs-Spuren. – Auxiliary-Eingangs-
Spuren können als Effekt-Sends, Zielspuren für 
Submixing und Bouncing, Eingänge für das Abhören 
und Verarbeiten von Audiosignalen (wie etwa von 
externen MIDI-Instrumenten kommende 
Audiosignale) und für viele weitere Routing-
Aufgaben verwendet werden.

Master-Fader-Spuren. – Master-Fader-Spuren 
steuern den Gesamtpegel der Audiospuren, die auf 
die Haupt-Ausgangspfade der Session geroutet sind. 
Sie können beispielsweise an einer Session mit 24 
Spuren arbeiten, wobei die Kanäle 1–8 auf den 
analogen Ausgang 1–2, die Kanäle 9–16 auf den 
analogen Ausgang 3–4 und die Kanäle 17–24 auf den 
analogen Ausgang 5–6 geroutet sind. Sie können 
dann drei Master-Fader erstellen, um jedes dieser 
Ausgabepaare zu steuern.

Master-Fader-Spuren können auch anderen 
Zwecken dienen (beispielsweise der Steuerung 
von Submixebenen). Weitere Informationen 
finden Sie unter „Master-Fader-Spuren und 
Signalfluss“ auf Seite 982.

VCA Master-Spuren (nur Pro Tools HD). – VCA 
Master-Spuren (oder VCA Master) emulieren den 
Betrieb spannungsgesteuerter Verstärkerkanäle 
auf analogen Mischpulten, wo ein VCA-Kanal-
Fader benutzt würde, um die Signalpegel anderer 
Kanäle auf dem Mischpult zu steuern, gruppieren 
oder auszugleichen.

VCA Master-Spuren leiten keine Audiosignale 
weiter, sodass sie keine Eingänge, Ausgänge, Sends 
oder Inserts haben. Einer VCA Master-Spur wird 
eine Mix-Gruppe zugewiesen, die im Assignment-
Selektor der VCA-Spur angezeigt wird.

Die Einstellungen der Spuren in dieser Gruppe, 
die sogenannten Slave-Spuren, werden durch die 
Einstellungen im VCA Master geändert. Weitere 
Informationen finden Sie unter „VCA Master-
Spuren“ auf Seite 985.

Die Funktionen von Videospuren werden unter 
Kapitel 52: „Video in Pro Tools“ beschrieben.
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MIDI-Spuren

In MIDI-Spuren werden MIDI-Daten 
aufgenommen, gespeichert und wiedergegeben. 
Beim Erstellen einer MIDI-Spur können Sie keine 
Spurformate auswählen, da durch MIDI-Spuren 
keine Audiodaten geleitet werden.

Instrumentenspuren

Instrumentenspuren sind eine besondere Art von 
Spuren. Sie bieten sowohl MIDI- als auch 
Audiofunktionen in ein und demselben Kanalzug. 
Instrumentenspuren erleichtern die Verwendung von 
Software- und Hardware-Instrumenten zum 
Aufnehmen und Abhören von MIDI-Instrumenten.

Videospuren

In Videospuren können Sie QuickTime- 
(Windows und Mac) oder Windows Media-Video 
(nur Windows Vista) hinzufügen oder importieren.

Mit einer Avid-Videoperipherie und Pro Tools 
können Sie Avid-Videodaten zur Pro Tools-
Timeline hinzufügen oder in diese importieren 
(siehe Kapitel 52: „Video in Pro Tools“.)

Videospuren werden nur im Edit-Fenster 
angezeigt, und Videos können im Videofenster 
angezeigt werden.

Spurformate

Monospuren

Mono-Audiospuren, Auxiliary-Eingangs-Spuren, 
Master-Fader-Spuren oder Instrumentenspuren 
steuern die Lautstärke und in manchen Fällen das 
Panorama für jeweils einen Audiokanal. 
Für Mono-Audiospuren wird nur eine Voice 
benötigt. Eine Monospur kann auch zu einem 
Mehrkanalausgang geroutet werden.

Stereospuren

Eine Stereo-Audiospur, eine Stereo-Auxiliary-
Eingangs-Spur, eine Stereo-Master-Fader-
Spur oder eine Instrumentenspur ist ein einzelner 
Kanalzug, der zwei Audiokanäle als Stereopaar 
wiedergibt. Für Stereospuren werden zwei Voices 
benötigt. 

Mehrkanalspuren 

(Nur Pro Tools HD)

Eine Mehrkanalspur ist ein einzelner Kanalzug, 
der mehrere Audiokanäle wiedergibt (3 bis 
8 Kanäle gleichzeitig). Dank dieser Funktion 
unterstützt Pro Tools Formate zum Mischen 
mehrerer Kanäle, u. a. LCRS, 5.1, 6.1 und andere. 
Für Audio-, Auxiliary-Eingangs-, Master-Fader- 
und Instrumentenspuren kann jedes beliebige 
unterstützte Mehrkanalformat verwendet werden.

Nähere Informationen zum Erstellen von 
Surround-Mischungen mit Pro Tools finden Sie in 
den folgenden Kapiteln:

• Kapitel 47: „Surround-Setup“

• Kapitel 48: „Mehrkanalspuren und Signal-
Routing“

• Kapitel 49: „Pannen und Mischen im Surround-
Format“
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Kanalzüge für Spuren im Mix-
Fenster

Audiospur-Kanalzüge
Jede Audiospur hat eigene Steuerelemente 
für Kanalzüge, u. a. für Lautstärke, Panorama, 
Scharfschalten, Abhören von Eingangssignalen 
(nur Pro Tools HD), Automationsmodus, 
Soloschalten, Stummschalten und Zuweisung 
von Voices.

Kanalzug einer Mono-Audiospur 

Inserts (A–E angezeigt)

Sends (A–E angezeigt)

Audioeingangs-/-ausgangspfade

Solo-/Mute-Schaltflächen

Automation Mode-Selektor

Spurnamen-Schaltfläche

Pan-Drehregler

Pegelanzeige

Lautstärke-Fader

Gruppen-ID

Output Window-Schaltfläche

Track Comments

Anzeige der Spurart

Voice-Selektor

Record Enable-Schaltfläche für eine Spur

Peak/Delay- und Headroom-Anzeige

Panorama-Anzeige

Delay Compensation-Bedienfeld

TrackInput Monitor (Schaltfläche)

Farbliche Spurkennzeichnung

Farbliche Spurkennzeichnung

HEAT-Spur-Steuerelemente 
(Nur Pro Tools HD mit HEAT-Option)
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Kanalzüge für Auxiliary-
Eingangs-Spuren
Jede Auxiliary-Eingangs-Spur hat eigene 
Steuerelemente für Kanalzüge, u. a. 
für Lautstärke, Panorama, Automationsmodus, 
Soloschalten und Stummschalten.

Kanalzüge für Master-Fader-
Spuren
Jede Master-Fader-Spur hat eigene 
Steuerelemente für Kanalzüge, u. a. für Lautstärke 
und Automationsmodus. 

Kanalzug für Stereo-Auxiliary-Eingangs-Spur 

Inserts (A–E angezeigt)

Sends (A–E angezeigt)

Audio Input/Output Path-Selektoren

Solo-/Mute-Schaltflächen

Automation Mode-Selektor

Spurnamen-Schaltfläche

Pan-Drehregler

Pegelanzeige

Lautstärke-Fader

Gruppen-ID

Track Comments

Anzeige der Spurart

Peak/Delay- und Headroom-Anzeige

Panorama-Anzeigen

Delay Compensation-Bedienfeld

Farbliche Spurkennzeichnung

Output Window-Schaltfläche

Kanalzug für Stereo-Master-Fader-Spur 

Inserts (A–E angezeigt)

Audio Output Path-Selektoren

Automation Mode-Selektor

Spurnamen-Schaltfläche

Pegelanzeige

Lautstärke-Fader

Gruppen-ID

Track Comments

Anzeige der Spurart

Peak/Delay- und Headroom-Anzeige

Delay Compensation-Bedienfeld

Farbliche Spurkennzeichnung

Output Window-Schaltfläche



Kapitel 13: Spuren 205

Kanalzüge für VCA Master-
Spuren
(Nur Pro Tools HD)

Jede VCA Master-Spur hat eigene Steuerelemente 
für Kanalzüge, darunter für Lautstärke, 
Scharfschalten, Abhören von Eingangssignalen, 
Automationsmodus, Soloschalten und 
Stummschalten.

Kanalzüge für MIDI-Spuren
Jede MIDI-Spur hat eigene Steuerelemente 
für Kanalzüge, u. a. für MIDI-Lautstärke, 
Panorama, Scharfschalten, Automationsmodus, 
Soloschalten, Stummschalten und für die 
Zuweisung von Patches und Kanälen. 

Weitere Informationen finden Sie unter 
„VCA Master-Spuren“ auf Seite 985.

VCA Master-Spur

Automation Mode-Selektor

Stummschaltung

TrackInput

Solo

Record Enable

Anzeige der Spurart

Track Comments

Farbliche 
Spurkennzeichnung

Lautstärkeanzeige

Gruppen-ID

Lautstärke-
Fader

Pegelanzeige

MIDI-Kanalzug 

MIDI Input-Selektor

MIDI-Lautstärke-Fader

MIDI-Pan-Drehregler

Spurnamen-Schaltfläche

MIDI Velocity-Anzeige

Automation Mode-Selektor

MIDI Output-Selektor

Record Enable

Patch Select

MIDI-Panorama-Anzeige

MIDI-Lautstärkenanzeige
Anzeige der Spurart

Gruppen-ID

Track Comments

Solo-/Mute-Schaltflächen

Farbliche Spurkennzeichnung
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Kanalzüge für 
Instrumentenspuren
Jede Instrumentenspur hat eigene 
Steuerelemente für den Kanalzug, u. a. für 
Audiolautstärke (wie eine Auxiliary-Eingangs-
Spur), Panorama, Automationsmodus, 
Soloschalten, Stummschalten und MIDI-
Scharfschalten (beispielsweise eine MIDI-Spur). 
Bei Instrumentenspuren steht ein zusätzliches 
Instruments-Bedienfeld mit Steuerelementen 
für MIDI-Eingänge und -Ausgänge sowie 
zum Stummschalten, für die Lautstärke und 
für das Panorama zur Verfügung (wie bei einer 
MIDI-Spur).

Kanalzug einer Stereo-Instrumentenspur 
(Instruments-Bedienfeld)

Inserts (A–E angezeigt)

Sends (A–E angezeigt)

Audio Input/Output Path-Selektoren

Solo-/Mute-Schaltflächen

Automation Mode-Selektor

Track Name

Pegelanzeige

Lautstärke-Fader

Gruppen-ID

Output Window-Schaltfläche

Track Comments

Anzeige der Spurart
Peak/Delay- und Headroom-Anzeige

Pan-Drehregler

Delay Compensation-Bedienfeld

Record Enable

Patch Select

MIDI Input-Selektor

MIDI Output-Selektor

MIDI-Anzeige (Velocity)

MIDI Volume

MIDI Mute-Schaltfläche

Farbliche Spurkennzeichnung

MIDI Pan

Panorama-Anzeigen
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Spur-Steuerelemente und -
Anzeigen im Edit-Fenster

Steuerelemente für 
Audiospuren
Jede Audiospur hat eigene Spur-Steuerelemente, u. a. 
für Spurnamen, Playlist, Scharfschalten, Abhören 
von Eingangssignalen (nur Pro Tools HD), 
Soloschalten, Stummschalten, Spurdarstellung, 
Darstellungshöhe der Spur, Elastic Audio, Voice-
Zuweisung und Automation-Modus. 

Steuerelemente für Auxiliary-
Eingangs-Spuren
Jede Auxiliary-Eingangs-Spur hat eigene Spur-
Steuerelemente, u. a. für Spurname, Soloschalten, 
Stummschalten, Spurdarstellung, Darstellungshöhe 
der Spur, Zeitbasis und Automation-Modus. 

Steuerelemente für Master-
Fader-Spuren
Jede Master-Fader-Spur hat eigene Spur-
Steuerelemente, u. a. für Spurname, 
Spurdarstellung, Darstellungshöhe der Spur, 
Zeitbasis und Automation-Modus. 

Edit-Fenster: Spur-Steuerelemente für Mono-
Audiospur (mittlere Darstellungshöhe)

Automation Mode-Selektor

Mute-Schaltfläche

Voice-Selektor

Track Height-Selektor

Playlist-Selektor

Track Name

Solo-Schaltfläche
TrackInput Monitor (Schaltfläche)

Timebase-Selektor

Elastic Audio-Plug-In-Selektor

Record Enable-Schaltfläche

Automations-Lanes ein-/ausblenden

Track View-
Selektor

Edit-Fenster: Spur-Steuerelemente für Stereo-
Auxiliary-Eingangs-Spur (mittlere Darstellungshöhe)

Edit-Fenster: Spur-Steuerelemente für Stereo-Master-
Fader-Spur (mittlere Darstellungshöhe)

Mute-Schaltfläche

Track Height-Selektor
Track Name

Timebase-Selektor

Track View-Selektor

Solo-Schaltfläche

Automationsmodus
Selektor

Automations-Lanes ein-/ausblenden

Track Height
Selektor

Track Name

Track View 
Selektor

Automation Mode-Selektor

Timebase-Selektor

Automations-Lanes
ein-/ausblenden
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Steuerelemente für VCA Master-
Spuren
(Nur Pro Tools HD)

Jede VCA Master-Spur hat eigene Spur-
Steuerelemente, u. a. für Spurnamen, Playlist, 
Scharfschalten, Abhören von Eingangssignalen, 
Soloschalten, Stummschalten, Spurdarstellung, 
Darstellungshöhe der Spur, Zeitbasis und 
Automation-Modus. 

MIDI-SpurenSteuerelemente
Jede MIDI-Spur hat eigene Spur-Steuerelemente, 
u. a. für Spurname, Playlist, Scharfschalten, 
Soloschalten, Stummschalten, Spurdarstellung, 
Darstellungshöhe der Spur, Patch, Zeitbasis und 
Automation-Modus. 

Edit-Fenster: Spur-Steuerelemente für VCA 
Master-Spur (mittlere Darstellungshöhe)

Mute-Schaltfläche

Track Height-Selektor

Track Name

Solo-Schaltfläche
TrackInput Monitor (Schaltfläche)

Record Enable-Schaltfläche

Automation Mode-Selektor
Timebase-Selektor

Automations-Lanes ein-/ausblenden

Edit-Fenster: Spur-Steuerelemente für MIDI-Spur 
(mittlere Darstellungshöhe)

Mute-Schaltfläche

Track Height-Selektor

Playlist-Selektor

Track Name
Solo-Schaltfläche

Record Enable-Schaltfläche

Automation Mode-Selektor
Patch-Selektor

Timebase-Selektor

Track View-Selektor

Controller-Lanes ein-/ausblenden
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Steuerelemente für 
Instrumentenspuren
Jede Instrumentenspur hat eigene Spur-
Steuerelemente, u. a. für Spurname, Playlist, 
Scharfschalten, Soloschalten, Stummschalten, 
Spurdarstellung, Darstellungshöhe der Spur, Patch, 
Zeitbasis und Automation-Modus.

Steuerelemente für 
Videospuren
Jede Videospur hat eigene Spur-Steuerelemente, u. a. 
für Spurname, Playlist, Online, Spurdarstellung und 
Darstellungshöhe der Spur. 

Bedienfelder im Edit-Fenster
Neben den Spur-Steuerelementen und Playlists 
(von Event-Clips auf der Timeline) bietet das Edit-
Fenster die folgenden Bedienfelder, die den 
Steuerelementen für Kanalzüge im Mix-Fenster 
entsprechen:

• Anmerkungen 

• Mic Preamps 

• Instrumente 

• Inserts (A–E und F–J)

• Sends (A–E und F–J)

• Anschlüsse 

• Echtzeit-Eigenschaften 

• Track Color 

• All 

• Minimal 

Edit-Fenster: Spur-Steuerelemente für Stereo-
Instrumentenspur (mittlere Darstellungshöhe)

Mute-Schaltfläche

Track Height-Selektor

Playlist 
Selektor

Track Name

Solo-Schaltfläche

Record Enable-Schaltfläche

Track View-
Selektor

Automation Mode-Selektor

Patch-Selektor

Timebase-Selektor

Automations- und Controller-Lanes ein-/ausblenden

Edit-Fenster: Spur-Steuerelemente für Videospur 
(mittlere Darstellungshöhe)

Siehe auch „Bedienfelder im Mix- und 
Edit-Fenster“ auf Seite 991.

Online (Schaltfläche)

Track Height-Selektor
Playlist-SelektorTrack Name

Track View-Selektor

Framerate-Anzeige
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Comments-Bedienfeld
Im Comments-Bedienfeld können Sie 
Anmerkungen zu einer bestimmten Aufgabe 
eingeben und anzeigen.

Mic Preamps-Bedienfeld
Im Mic Preamps-Bedienfeld werden Steuerelemente 
für Spuren mit physikalischen Audioeingängen 
angezeigt, die über PRE geroutet werden. 

Instruments-Bedienfeld
Das Instruments-Bedienfeld bietet MIDI-
Steuerelemente für Instrumentenspuren: MIDI Input-
Selektor, MIDI Output-Selektor, MIDI-Lautstärke, 
MIDI-Panorama und MIDI-Stummschaltung.

Inserts-Bedienfeld (A–E und F–J)
Das Inserts-Bedienfeld liefert bis zu zehn Inserts 
(Software-Plug-Ins oder Hardware-I/O-Inserts für 
das Generieren und Verarbeiten von Audiodaten) für 
jede Audio-, Auxiliary-Eingangs-, Master-Fader- 
und Instrumentenspur. 

Sends-Bedienfeld (A–E und F–J)
Das Sends-Bedienfeld zeigt Send-Zuweisungen in 
jeder Audio-, Auxiliary-Eingangs- und 
Instrumentenspur an. 

I/O-Bedienfeld
Im I/O-Bedienfeld des Edit-Fensters stehenInput- 
und Output-Selektoren für Audio-, Auxiliary-
Eingangs-, Master-Fader- (nur Ausgabe), MIDI- 
und Instrumentenspuren zur Verfügung (diese 
entsprechen den gleich benannten 
Steuerelementen im Mix-Fenster).

So zeigen Sie das I/O-Bedienfeld im Edit-Fenster an:

 Wählen Sie View > Edit Window > I/O.

Anzeige für Lautstärke/Peak/Channel Delay

Die Lautstärkeanzeige einer Audiospur weist drei 
Anzeigemodi auf: Lautstärke (Volume), 
Spitzenwertanzeige (Peak) und Channel Delay.

Weitere Informationen zum Comments-
Bedienfeld finden Sie unter „Hinzufügen von 
Anmerkungen zu Spuren“ auf Seite 222.

Weitere Informationen hierzu finden Sie im 
PRE-Handbuch.

Weitere Informationen finden Sie unter „Zuweisen 
von MIDI-Eingängen und -Ausgängen für 
Instrumentenspuren“ auf Seite 245.

Weitere Informationen zu Inserts finden Sie 
unter Kapitel 44: „Plug-In- und Hardware-
Inserts“.

Weitere Informationen finden Sie unter 
„Konfigurieren des Sends-Bedienfelds im 
Mix- und Edit-Fenster“ auf Seite 1002.

I/O-Bedienfeld im Edit-Fenster (Audiospur)

Da die Kanalzüge im Mix-Fenster immer mit 
den Input- und Output-Selektoren sowie den 
Lautstärke- und Panoramawerten angezeigt 
werden, steht im Mix-Fenster keine gesonderte 
Option zum Einblenden des I/O-Bedienfelds 
zur Verfügung.

Weitere Informationen zu Input- und Output-
Selektoren finden Sie unter „Zuweisen von 
Audio-Ein- und Ausgängen an Spuren“ auf 
Seite 236.

Input Path-Selektor

Output Path-Selektor

Lautstärkeanzeige

Panorama-Anzeige

Output Window-Schaltfläche
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So wechseln Sie zwischen den Anzeigen:

 Klicken Sie bei gedrückter Strg- (Windows) 
bzw. Befehlstaste (Mac) auf die Schaltfläche, 
um zwischen den folgenden Modi zu wechseln:

Lautstärkeanzeige (und Popup-Fader). – zeigt 
den gegenwärtigen Lautstärke- bzw. 
Eingangspegel einer Spur entsprechend der 
Lautstärke-Fader-Position an. Wenn Sie im I/O-
Bedienfeld des Edit-Fensters auf die 
Lautstärkeanzeige klicken, wird der Lautstärke-
Popup-Fader angezeigt, mit dem Sie die 
Lautstärke einstellen können.

Spitzenwertanzeige (Peak). – Headroom-Anzeige, 
die auf dem letzten Spitzenpegel der Wiedergabe 
basiert. Klicken Sie auf eine beliebige Stelle in der 
Anzeige, um die Spitzenwertanzeige zurückzusetzen. 
Die Werte liegen zwischen –∞ (kein Signal) und 0 dB. 

Panorama-Anzeige

Die Panorama-Anzeige zeigt die momentane 
Panoramaeinstellung einer Spur an. 
Die Panoramawerte reichen von <100 (ganz links) 
bis 100> (ganz rechts). Pan-Einstellungen sind nur 
für Stereospuren oder für auf einen Stereoausgang 
geroutete Monospuren verfügbar.

Wenn Sie im I/O-Bedienfeld des Edit-Fensters auf 
die Panorama-Anzeige klicken, wird der Panorama-
Popup-Regler angezeigt, mit dem Sie den 
Panoramawert einstellen können.

Panorama-Schieberegler

Der Panoramaregler steuert die Balance eines 
Spursignals in dem zugewiesenen Ausgangspaar. 
Er wird nur angezeigt, wenn Sie mit einer 
Stereospur oder einer auf einen Stereoausgang 
gerouteten Monospur arbeiten.

Der Panoramaregler einer MIDI-Spur ist nur 
wirksam, wenn Sie ein Soundmodul steuern, 
das MIDI-Panoramaregelung unterstützt.

Lautstärke-Fader

Der Lautstärke-Fader steuert den Wiedergabepegel 
einer Spur während der Wiedergabe und den 
Abhörpegel der Spur während der Aufnahme. 
Sie können die Aufnahme- und Abhörpegel 
miteinander koppeln, indem Sie in den Betriebs-
Voreinstellungen (Operation) die Link Record and 

Play Faders-Option aktivieren.

Die maximale Fader-Verstärkung für einen 
Lautstärke-Fader beträgt +12 dB.

I/O-Bedienfeld im Edit-Fenster, Lautstärke-Popup-
Fader (Audiospur)

I/O-Bedienfeld im Edit-Fenster, Panorama-Popup-
Regler (Audiospur)

Für Mehrkanalspuren wird keine Panorama-
Anzeige im I/O-Bedienfeld angezeigt. Sie 
können die Mehrkanal-Panoramaregelung 
im Output-Fenster der Spur oder im Mix-
Fenster anzeigen und anpassen.

Pan-Einstellungen eines Sends können mit den 
Main Pan-Einstellungen einer Spur gekoppelt 
werden, indem Sie die Follow Main Pan-
Schaltfläche im Send-Fenster aktivieren.
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MIDI-Lautstärke-Fader

Wenn das MIDI-Soundmodul Lautstärke unterstützt, 
kann der Lautstärke-Fader einer MIDI- oder 
Instrumentenspur Werte zwischen 0 und 127 an den 
MIDI-Lautstärke-Controller senden.

Echtzeit-Eigenschaften
Im Edit-Fenster haben Sie über das Real-Time 
Properties-Bedienfeld Zugriff auf die Einstellungen 
für Echtzeit-Eigenschaften (beispielsweise Quantize 
oder Transpose) auf MIDI- und Instrumentenspuren. 
Weitere Informationen finden Sie unter „MIDI-
Echtzeit-Eigenschaften“ auf Seite 726.

Track Color
Im Track Color-Bedienfeld des Edit-Fensters wird 
ganz links in den Spureinstellungen der 
Spurfarbenstreifen angezeigt.

Pegelanzeige für Spuren
Bei Audiospuren zeigen die Pegelanzeigen den 
Signalpegel während der Aufnahme oder 
Wiedergabe auf bzw. von der Festplatte an. Wenn 
eine Spur scharfgeschaltet oder „Input 
Monitoring“ aktiviert ist, geben diese Anzeigen 
die Aufnahme- bzw. Input Monitoring-Pegel an.

Bei Auxiliary-Eingangs-, Master-Fader- und 
Instrumentenspuren zeigen die Pegelanzeigen den 
Pegel des über den Kanalausgang 
wiedergegebenen Signals an. 

Bei MIDI-Spuren und im Instruments-Bedienfeld 
für Instrumentenspuren zeigt die Pegelanzeige die 
MIDI-Velocity des letzten MIDI-Events an.

Stereo-Audiospur mit Signal- und Gain-Reduction-
Anzeigen im Mix-Fenster (Pro Tools HD)

Pegelanzei-
geskala

Fader-Gain-
Skala

Übersteue-
rungsanzeige

Gain-
Reduction-
Anzeige (nur 
Pro Tools HD)

Spursig-
nalanzeigen
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Fader-Gain-Skala

Die Fader-Gain-Skala gibt die Gain-Verstärkung 
oder -Dämpfung des Signals durch das Fader-
Bedienelement an. 

Pegelanzeigeskala. – zeigt die Pegelskala für den 
ausgewählten Anzeigetyp (siehe „Erweitertes 
Metering“ auf Seite 216).

Gain-Reduction-Anzeige (nur Pro Tools HD). 
Pro Tools HD bietet eine optionale Gain 
Reduction-Anzeige rechts neben den Audiopegeln 
bei jenen Auxiliary-Eingangs-, Instrumenten- und 
Master-Fader-Spuren, die dynamische Plug-Ins wie 
Avid Pro Compressor und Pro Expander 
unterstützen. Weitere Informationen finden Sie 
unter „Konfigurieren der Gain-Reduction-
Anzeigen“ auf Seite 218.

Spursignalanzeige. Bei Audio-, Auxiliary-
Eingangs-, Instrumenten-, VCA- (nur Pro Tools HD) 
und Master-Fader-Spuren wird über den 
Spurenanzeigen ein grünes Rautesymbol 
eingeblendet, das für 0 dB (digital) auf der 
Anzeigeskala steht. Wenn sich 0 dB (digital) über der 
aktuellen Anzeigeskala befindet, bewegt sich das 
Rautesymbol an das obere Ende der Anzeige und 
ändert die Farbe zu orange.

Clip-Anzeige. – leuchtet rot bei einer Übersteuerung 
an den Eingangs- oder Ausgangswandlern des Audio-
Interface oder bei einer Übersteuerung während des 
Schreibens in eine 16- oder 24-Bit-Audiodatei. Die 
Clip-Anzeige leuchtet gelb, wenn das Signal im 
internen Mixer 0 dBFS überschreitet. Weitere 
Informationen finden Sie unter 
„Übersteuerungsanzeige“ auf Seite 214.

Pre- und Post-Fader-Pegelanzeige
Sie können global festlegen, ob Pegelanzeigen für 
Audiospuren Pre- oder Post-Fader-Pegel anzeigen 
sollen. Wenn Pre-Fader Metering aktiviert ist, zeigen 
Pegelanzeigen die Pegel unabhängig von der Position 
des Faders an. Bei der Post-Fader-Pegelanzeige 
entsprechen die Pegelanzeigen der jeweils aktuellen 
Fader-Position.

So schalten Sie die Pegelanzeige für Spuren 
zwischen Pre-Fader- und Post-Fader-Einsatz um:

 Wählen Sie Options > Pre-Fader Metering.

Peak Hold
Pro Tools-Pegelanzeigen bieten eine Peak Hold-
Funktion zur Anzeige von Spitzenwerten mit den 
folgenden drei Optionen: 3 Second, Infinite 
oder None.

So wählen Sie eine Peak Hold-Einstellung:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Metering-Registerkarte.

2 Wählen Sie eine Peak Hold-Option.

3 Klicken Sie auf OK.

So setzen Sie eine Pegelanzeige zurück:

 Klicken Sie auf eine beliebige Stelle 
der Anzeige. 

Sie haben folgende Möglichkeiten, 
die Pegelanzeige zurückzusetzen:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf eine der Anzeigen.

 Wählen Sie Track > Clear All Clip Indicators.

 Drücken Sie Wahl + C (Mac) bzw. Alt + C 
(Windows).
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Übersteuerungsanzeige
Da Pro Tools 64-Bit-Gleitkomma-Verarbeitung 
für den Mixer verwendet, gibt es keine interne 
Übersteuerung im Mixer. Es ist jedoch möglich, an 
den Wandlern Ihres Audio-Interface zu 
übersteuern. Clipping kann auch beim Schreiben 
von Audiodaten auf die Festplatte in Audiodateien 
mit Festekomma-Verarbeitung auftreten (nur 16- 
und 24-Bit-Dateien; kein Übersteuern bei 32-Bit-
Gleitkomma-Dateien).

Pro Tools-Pegelanzeigen bieten eine 
Übersteuerungsanzeige mit den folgenden drei 
Optionen: 3 Second, Infinite oder None. Wenn es 
zu Übersteuerungen (Clipping) kommt, leuchtet 
die oberste LED permanent.

So wählen Sie eine Clip Indication-Einstellung aus:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Metering-Registerkarte.

2 Wählen Sie eine Clip Indication-Option aus.

3 Klicken Sie auf OK.

So setzen Sie alle Übersteuerungsanzeigen zurück:

 Klicken Sie auf eine beliebige Stelle 
der Anzeige. 

Sie haben folgende Möglichkeiten, alle 
Übersteuerungsanzeigen zurückzusetzen:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf eine der Anzeigen.

 Wählen Sie Track > Clear All Clip Indicators.

 Drücken Sie Wahl + C (Mac) bzw. Alt + C 
(Windows).

Aussteuerungsanzeigen für die Master-
Fader-Spur

Übersteuerungsanzeigen für die Master-Fader-
Spur erscheinen rot, wenn das Audiosignal 0 dBFS 
überschreitet. Dies führt zu einem Übersteuern bei 
den Ausgangswandlern Ihres Audio-Interface. 
Dieses Verhalten wird in den Ausgangsanzeigen 
unter „Transport“ gespiegelt.

Die Übersteuerungsanzeigen werden im 
Plug-In-, Send- und Track-Fenster angezeigt.

Audio-, Auxiliary-Eingangs-, Instrumenten- und 
Master-Fader-Spuren mit Übersteuerung
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Aussteuerungsanzeigen für 
die Audiospur

Die Aussteuerungsanzeigen für die Audiospur 
erscheinen unter den folgenden Bedingungen in 
rot (sonst gelb):

• wenn eine Audiospur scharfgeschaltet oder auf 
„Input Monitoring“ geschaltet und die 
Eingangszuweisung auf ein physisches 
Eingangssignal über 0 dBFS eingestellt ist, was zu 
einer Übersteuerung bei den Wandlern führt.

• Wenn eine Audiospur bei einer Festkomma-
Bitrate (16 oder 24 Bit) aufgenommen und das 
auf die Festplatte geschriebene Audiosignal 
0 dBFS überschreitet, was zum Clipping in der 
Datei führt.

Übersteuerungsanzeigen für Auxiliary-
Eingangs- und Instrumentenspuren 
und Sends

Die Übersteuerungsanzeigen für Auxiliary-
Eingangs-Spuren, Instrumentenspuren und Sends 
erscheinen in gelb, wenn das Signal 0 dBFS 
überschreitet (auch ohne interne Übersteuerung). 
Dies dient als Warnung dafür, dass diese 
Audioströme bei den Ausgangswandlern oder 
beim Schreiben von Dateien im Festkomma-
Format auf die Festplatte übersteuern können.

Wide Meters-Bedienfeld
In diesem Bedienfeld werden die Spur-
Pegelanzeigen sowohl im Mix- als auch im 
Edit-Fenster verbreitert, damit sie leichter gelesen 
werden können. Die breite Pegelanzeige wird 
ebenfalls für die Narrow Mix-
Darstellung unterstützt.

So schalten Sie das Wide Meters-Bedienfeld ein 
und aus:

 Klicken Sie bei gedrückter Befehls-, Wahl- und 
Ctrl-Taste (Mac) bzw. Strg-, Alt- und Windows-
Taste (Windows) auf die Spur-Pegelanzeigen 
im Mix- oder Edit-Fenster.

Wide Meters-Bedienfeld, Mix- und Edit-Fenster
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Anzeigen oder Verbergen von 
Anzeigen und Fadern
In Pro Tools können Sie Anzeigen und Fader im 
Mix-Fenster anzeigen oder verbergen. Dies kann 
nützlich sein, um Platz auf dem Bildschirm zu 
schaffen, insbesondere wenn Sie mit einer 
Bedienoberfläche arbeiten.

Führen Sie einen der folgenden Schritte aus, 
um Anzeigen und Fader im Mix-Fenster 
anzuzeigen (bzw. auszublenden):

 Aktivieren (oder deaktivieren) Sie die Option 
View > Mix Window Views > Meters and Faders

 Aktivieren (oder deaktivieren) Sie über den 
Ansichts-Selektor des Mix-Fensters die Meters 

and Faders-Option.

Erweitertes Metering
In Pro Tools können Sie die Ballistikeigenschaften 
und Skalen für das visuelle Monitoring von 
Audiopegeln an Ihre Bedürfnisse anpassen. Für die 
meisten Benutzer passen die Standardeinstellungen 
für die einzelnen Anzeigetypen am besten. 
Für einige Broadcasting-, Postproduktions- sowie 
Misch- und Mastering-Studios können hingegen 
andere Metering-Optionen ausgewählt und das 
Metering in Pro Tools so an diverse externe Konsolen 
oder andere Geräte angepasst werden. 

Fader- und Pegelanzeige

Im Mix-Fenster von Pro Tools wird links neben dem 
Lautstärke-Fader für die Spur eine Gain-Verstärkungs- 
und -Dämpfungsskala in dB eingeblendet. Diese reicht 
von +12 dB bis zu –INF dB. Die Skala gibt an, wie 
stark der Audiopegel für die Spur durch die Bewegung 
des Faders beeinflusst wird. In bestimmten Fällen wie 
bei der breiten Pegelanzeige oder Mehrkanalformaten 
(höher als Stereo) wird die Fader-Skala nicht 
eingeblendet.

Die Werte zwischen dem Fader und den Anzeigen 
verändern sich je nach ausgewähltem Meter Type. 
Beispielsweise reicht die Anzeigeskala beim 
Anzeigetyp Peak von 0 bis –60 dB bzw. beim 
Verfahren VU von +3 bis –20 dB.

Ansichts-Selektor des Mix-Fensters

Verschiedene Pegelanzeigeskalen

Pegelanzei-
geskala

Peak VU
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Positionierung der Gain-
Reduction-Anzeige
(Nur Pro Tools HD)

Die Positionierung der Gain-Reduction-Anzeige 
(sofern angezeigt) hängt von der Skala des 
gewählten Anzeigetyps ab. Das obere Ende der 
Gain-Reduction-Anzeige entspricht immer dem 
Referenzpegel für das gewählte Anzeigetyp, 
während das untere Ende der Gain-Reduction-
Anzeige dem gewählten Meter Type entspricht.

Festlegen des Anzeigetyps

Sie können den Anzeigetyp entweder in den 
Metering-Voreinstellungen von Pro Tools oder 
mittels Rechtsklick auf das Meter-Menü festlegen. 
Je nach den Einstellungen unter Track and 

Master Meter Types Linked können Sie die 
Anzeigetypeinstellungen für Spur (Audio-, 
Auxiliary-Eingangs- oder Instrumentenspur) und 
Master (Master-Fader-Spur) getrennt anpassen.

So legen Sie den Anzeigetyp für Spur- und Master-
Anzeigen in den Voreinstellungen von Pro Tools fest:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Metering-Registerkarte .

3 Aktivieren bzw. deaktivieren Sie die Track and 

Master Meter Types Linked-Einstellung 
wie gewünscht.

4 Sie haben folgende Möglichkeiten:

• Falls die Track and Master Meter Types Linked-
Einstellung aktiviert ist, wählen Sie den 
gewünschten Anzeigetyp im Popup-Menü Track 

Meters bzw. Master Meters.

• Falls die Einstellung Track and Master Meter 

Types Linked deaktiviert ist, wählen Sie den 
Anzeigetyp für die Spurenanzeigen im Popup-
Menü Track Meters bzw. den Anzeigetyp für 
Master-Anzeigen im Popup-Menü Master Meters.

5 Klicken Sie auf OK.

So stellen Sie den Spuranzeigetyp im Mix- oder 
Edit-Fenster ein:

1 Klicken Sie mit der rechten Maustaste auf eine 
beliebiges Spurenanzeigesymbol.

2 Wählen Sie aus dem Meter Type-Menü die 
gewünschte Option.

Positionierung der Gain-Anzeigen in 
der Pegelanzeigeskala

Einzelheiten zu den verfügbaren Anzeigetypen 
finden Sie unter „Spur- und Master-Meter-
Typen“ auf Seite 120.

Peak VU K-20
Klicken Sie bei gedrückter Wahltaste- (Mac) 
bzw. Alt-Taste (Windows) mit der rechten 
Maustaste in einer beliebigen Spurenanzeige 
und wählen Sie „Meter Type“ wie 
gewünscht, um die gleichen Einstellungen für 
sämtliche Spurtypen zu übernehmen, 
unabhängig von der Option „Track and 
Master Meter Types Linked“.

Falls in den Metering-Voreinstellungen von 
Pro Tools die „Track and Master Meter 
Types Linked“-Option aktiviert ist, werden 
Master-Anzeigen auch auf den ausgewählten 
Anzeigetyp gesetzt.
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So stellen Sie den Master-Anzeigetyp im Mix- oder 
Edit-Fenster ein:

1 Klicken Sie mit der rechten Maustaste auf eine 
beliebiges Master-Anzeigesymbol.

2 Wählen Sie aus dem Meter Type-Menü die 
gewünschte Option.

Konfigurieren der Gain-Reduction-
Anzeigen
(Nur Pro Tools HD)

Sie können die Gain-Reduction-Anzeigen entweder 
in den Metering-Voreinstellungen von Pro Tools oder 
mittels Rechtsklick auf das Meter-Menü festlegen. 
Die Einstellungen für die Gain-Reduction-Anzeige 
gelten gleichermaßen für Spur- und Master-
Anzeigen, ungeachtet der Einstellungen unter Track 

and Master Meter Types Linked.

So konfigurieren Sie den Gain-Reduction-
Anzeigetyp:

 Klicken Sie auf Setup > Preference > Metering 
und wählen Sie unter Gain Reduction Meter 

Type die gewünschte Option.

 Klicken Sie mit der rechten Maustaste auf eine 
beliebige Spurenanzeige und wählen Sie aus 
dem Gain Reduction Meter Type-Menü und 
demGain Reduction-Untermenü die 
gewünschte Option.

Falls in den Metering-Voreinstellungen von 
Pro Tools die Option „Track and Master 
Meter Types Linked“ aktiviert ist, werden 
sämtliche Spurenanzeigen auf den 
ausgewählten Anzeigetyp gesetzt.

Auswählen des Anzeigetyps im Mix-Fenster 
(für Pro Tools HD)

Aktivieren von Gain-Reduction-Anzeigen im Mix-
Fenster
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Einstellen der Spurbreite
(Mix-Fenster)

Mit dem Narrow Mix-Befehl können Sie die Breite 
aller Spuren bzw. Kanäle im Mix-Fenster verringern, 
um in einer großen Session mehr Platz auf dem 
Bildschirm zu haben. (Informationen zum Einstellen 
der Darstellungshöhe einer Spur im Edit-Fenster 
finden Sie unter „Darstellungshöhe von Spuren“ auf 
Seite 230.)

So verringern Sie die Breite der Spuren im Mix-
Fenster:

 Wählen Sie View > Narrow Mix.

So zeigen Sie Spuren in normaler Breite an:

 Heben Sie die Auswahl von View > Narrow 

Mix auf.

Erstellen von Spuren
Sie können auf allen Pro Tools-Systemen Mono- 
und Stereospuren erstellen. In Pro Tools HD 
können Sie auch Mehrkanalspuren erstellen 
(von LCR bis 7.1).

Eine neue Spur erhält automatisch einen 
Standardnamen, der jederzeit geändert 
werden kann.

 Wenn Sie direkt neben einer bestimmten Spur in 
der Session eine neue Spur einfügen möchten, 
wählen Sie vor dem Öffnen des New Tracks-
Dialogfelds die entsprechende Spur aus, indem Sie 
im Edit- oder Mix-Fenster auf deren Namen 
klicken. Die neuen Spuren werden direkt hinter der 
ausgewählten Spur eingefügt. 

 Um im Anschluss an die letzte Spur einer 
Session neue Spuren einzufügen, stellen Sie sicher, 
dass vor dem Öffnen des New Tracks-Dialogfelds 
auf dem Bildschirm keine Spurnamen ausgewählt 
sind.

So erstellen Sie neue Spuren:

1 Sie haben folgende Möglichkeiten, um das New 
Track-Dialogfeld zu öffnen:

• Wählen Sie Track > New.

• Klicken Sie mit der rechten Maustaste im Mix- 
oder Edit-Fenster oder in der Tracks-Liste auf 
einen Spurnamen und wählen Sie New.

2 Wählen Sie im Track Type-Popup-Menü die Art 
der Spur aus, die Sie hinzufügen möchten. 

Die Spurbreite kann durch Drücken von 
Befehl + Wahl + M (Mac) bzw. Strg + Alt + 
M (Windows) umgeschaltet werden.

Sie können Spuren auch durch Importieren 
aus bereits vorhandenen Sessions Ihrer 
Session hinzufügen. Siehe „Importieren von 
Session-Daten“ auf Seite 346.

Drücken Sie Strg + Umschalt + N (Windows) 
bzw. Befehl + Umschalt + N, um das New 
Tracks-Dialogfeld zu öffnen.

New Tracks-Dialogfeld

Um das Track Type-Popup-Menü des New 
Tracks-Dialogfelds automatisch 
durchzugehen, halten Sie die Befehlstaste 
(Mac) bzw. Strg-Taste (Windows) gedrückt 
und verwenden Sie die Nach-oben- oder 
Nach-unten-Pfeiltaste.

Anzahl der neuen Spuren

Spurformat

Spurart

Spur-Zeitbasis

Add/Remove Row
(Zeile hinzufügen/entfernen)
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3 Wählen Sie im Track Format-Popup-Menü das 
gewünschte Format (Mono, Stereo oder eines 
der Mehrkanal-Surround-Formate) aus. 
Surroundformate sind nur in 
Pro Tools HD verfügbar.

4 Wählen Sie im Track Timebase-Popup-Menü die 
gewünschte Zeitbasis (Samples oder Ticks) aus.

5 Geben Sie die Anzahl der neuen Spuren ein.

6 Sie haben folgende Möglichkeiten:

• Wenn Sie weitere Spuren hinzufügen möchten, 
klicken Sie auf die Add Row-Schaltfläche.

• Um eine Spur zu entfernen, klicken Sie auf die 
Remove Row-Schaltfläche.

7 Um die Anordnung der Spuren zu ändern, 
klicken Sie auf das Move Row-Symbol und 
ziehen Sie es nach oben oder nach unten.

8 Klicken Sie auf Create.

Hinzufügen neuer Spuren durch 
Doppelklicken im Edit- oder 
Mix-Fenster
In Pro Tools können Sie neue Spuren hinzufügen, 
indem Sie in den leeren Bereich unter den Spuren (im 
Edit-Fenster) bzw. unter oder rechts neben den 
Spuren (im Mix-Fenster) doppelklicken.

Sie haben folgende Möglichkeiten, um eine neue Spur 
desselben Typs und mit der gleichen Kanalanzahl wie 
bei der letzten neuen Spur hinzuzufügen:

 Doppelklicken Sie in den leeren Bereich des 
Mix-Fensters unter oder rechts neben einer 
beliebigen aktuellen Spur.

 Doppelklicken Sie in den leeren Bereich des 
Edit-Fensters unter einer beliebigen aktuellen 
Spur.

 Doppelklicken Sie in den leeren Bereich 
unter einer beliebigen aktuellen Spur in 
der Spurenliste

Falls keine Spuren für die Session vorhanden sind, 
wird standardmäßig eine Stereo-Audiospur erstellt.

Um das Track Format-Popup-Menü 
automatisch durchzugehen, halten Sie die 
Befehls- (Mac) bzw. Strg-Taste (Windows) 
gedrückt und verwenden Sie die Nach-oben- 
oder Nach-unten-Pfeiltaste.

Um das Track Format-Popup-Menü 
automatisch durchzugehen, halten Sie die 
Befehls- und Wahltaste (Mac) bzw. Strg- und 
Alt-Taste (Windows) gedrückt und 
verwenden Sie die Nach-oben- oder Nach-
unten-Pfeiltaste.

Wenn Sie eine Reihe mehrerer neuer Spuren 
erstellen, können Sie in das Feld mit der Anzahl 
der neuen Spuren der nächsten oder vorherigen 
Zeile springen, indem Sie die Tab-Taste bzw. 
Tab- und Umschalttaste drücken.

Um eine neue Spur hinzuzufügen, drücken Sie 
Befehl + N (Mac) bzw. Strg + N (Windows) 
oder geben Sie auf dem Ziffernblock Strg + 
Pluszeichen (+) (Windows) bzw. Befehl + 
Pluszeichen (+) (Mac) ein. 

Um die letzte Spur im New Tracks-Dialogfeld 
zu entfernen, drücken Sie Befehl + 
Minuszeichen (–) (Mac) bzw. Strg- + 
Minuszeichen (–) (Windows).

Move Row-Symbol im New Tracks-Dialogfeld
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Sie haben folgende Möglichkeiten, um eine neue 
Audiospur mit der gleichen Kanalanzahl wie bei 
der letzten neuen Spur hinzuzufügen:

 Doppelklicken Sie bei gedrückter Befehlstaste 
(Mac) bzw. Strg-Taste (Windows) in den leeren 
Bereich des Mix-Fensters unter oder rechts 
neben einer beliebigen aktuellen Spur.

 Doppelklicken Sie bei gedrückter Befehlstaste 
(Mac) bzw. Strg-Taste (Windows) in den leeren 
Bereich des Edit-Fensters unter einer beliebigen 
aktuellen Spur.

 Doppelklicken Sie bei gedrückter Befehlstaste 
(Mac) bzw. Strg-Taste in den leeren Bereich 
unter einer beliebigen aktuellen Spur in 
der Spurenliste.

Falls keine Spuren für die Session vorhanden sind, 
wird standardmäßig eine Stereo-Audiospur erstellt.

Sie haben folgende Möglichkeiten, um eine neue 
Aux-Eingangs-Spur mit der gleichen Kanalanzahl 
wie bei der letzten neuen Spur hinzuzufügen:

 Doppelklicken Sie bei gedrückter Befehlstaste 
(Mac) oder Windows-Taste (Windows) in den 
leeren Bereich des Mix-Fensters unter oder 
rechts neben einer beliebigen aktuellen Spur.

 Doppelklicken Sie bei gedrückter Strg-Taste 
(Mac) bzw. Windows-Taste (Windows) in den 
leeren Bereich des Edit-Fensters unter einer 
beliebigen aktuellen Spur.

 Doppelklicken Sie bei gedrückter Strg-Taste 
(Mac) oder Windows-Taste (Windows) in den 
leeren Bereich unter einer beliebigen aktuellen 
Spur in der Spurenliste.

Falls keine Spuren für die Session vorhanden sind, 
wird standardmäßig eine Stereo-Aux-Eingangs-
Spur erstellt.

Sie haben folgende Möglichkeiten, um eine neue 
Master-Fader-Spur mit der gleichen Kanalanzahl 
wie bei der letzten neuen Spur hinzuzufügen:

 Doppelklicken Sie bei gedrückter 
Umschalttaste in den leeren Bereich des Mix-
Fensters unter oder rechts neben einer 
beliebigen aktuellen Spur.

 Doppelklicken Sie bei gedrückter 
Umschalttaste in den leeren Bereich des Edit-
Fensters unter einer beliebigen aktuellen Spur.

 Doppelklicken Sie bei gedrückter 
Umschalttaste (Mac) in den leeren Bereich 
unter einer beliebigen aktuellen Spur in 
der Spurenliste.

Falls keine Spuren für die Session vorhanden sind, 
wird standardmäßig eine Stereo-Master-Fader-
Spur erstellt.

Standardspurnamen
Beim Erstellen neuer Audio-, Auxiliary-Eingangs-, 
Master-Fader-, VCA Master-, MIDI- und 
Instrumentenspuren erhalten diese in Pro Tools die 
Bezeichnung „Audio“, „Aux“, „Master“, „VCA“, 
„MIDI“ oder „Inst“ und werden fortlaufend 
nummeriert. Wenn Sie beispielsweise die ersten 
zwei Audiospuren in einer neuen Session erstellen, 
werden diese standardmäßig als „Audio 1“ und 
„Audio 2“ bezeichnet. Sie können Spuren 
umbenennen und darüber hinaus Anmerkungen für 
jede Spur hinzufügen.
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Benennen von Spuren
Zum automatischen Benennen der 
aufgenommenen Audiodateien und -Clips werden 
Spurnamen verwendet.

So benennen Sie eine Spur um:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie im Mix- oder Edit-
Fenster auf die Schaltfläche mit dem 
betreffenden Spurnamen.

• Klicken Sie in der Tracks-Liste oder im Edit- 
oder Mix-Fenster mit der rechten Maustaste auf 
den Spurnamen der Spur, die Sie umbenennen 
möchten.

2 Geben Sie im Track Name/Comments-Dialogfeld 
einen neuen Namen für die Spur ein.

3 Klicken Sie auf Previous bzw. Next, um andere 
angezeigte Spuren umzubenennen.

4 Klicken Sie auf OK.

Hinzufügen von Anmerkungen 
zu Spuren

Führen Sie zum Hinzufügen von Anmerkungen 
zu Spuren einen der folgenden Schritte aus:

 Klicken Sie direkt im Kanalzug in den 
Anmerkungsbereich, geben Sie die Anmerkungen 
zur Spur ein und drücken Sie die Eingabe- 
(Windows) bzw. Return-Taste (Mac). 

 Doppelklicken Sie im Edit- oder Mix-Fenster 
auf die Schaltfläche mit dem betreffenden 
Spurnamen. Klicken Sie dann direkt in den 
Anmerkungsbereich, geben Sie Ihre 
Anmerkungen ein und drücken Sie die Eingabe- 
(Windows) bzw. Return-Taste (Mac). 

Nummerierung von Spuren
Bei aktivierter Spurnummerdarstellung wird jeder 
Spur entsprechend ihrer Position im Mix- und 
Edit-Fenster eine Nummer zugewiesen. Bei der 
Neuanordnung von Spuren werden die Spuren neu 
nummeriert, um die Ordnung nach Position 
beizubehalten.

So aktivieren Sie die Spurnummerdarstellung:

 Wählen Sie View > Track Number.

So navigieren Sie direkt zu einer Spurnummer:

1 Wählen Sie Track > Scroll to Track.

Track Name/Comments-Dialogfeld

Um im Track Name/Comments-Dialogfeld 
zur vorherigen bzw. nächsten Spur zu 
wechseln, halten Sie die Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) gedrückt 
und verwenden Sie die Nach-oben- oder 
Nach-unten-Pfeiltaste.

Um im Anmerkungsbereich einen 
Zeilenumbruch vorzunehmen, drücken Sie 
Umschalt + Eingabe (Windows) bzw. 
Umschalt + Return (Mac) auf der 
alphanumerischen Tastatur.

Drücken Sie Befehl + Wahl + F (Mac) 
bzw. Strg + Alt + F (Windows), um das 
Scroll To Track-Dialogfeld zu öffnen.



Kapitel 13: Spuren 223

2 Geben Sie im Scroll To Track-Dialogfeld die 
Positionsnummer der gewünschten Spur ein.

3 Klicken Sie auf OK.

Selektieren von Spuren
Sollen Spuren dupliziert oder einer Gruppe 
hinzugefügt oder ähnliche Vorgänge ausgeführt 
werden, müssen die Spuren zuvor selektiert 
werden. Es ist möglich, mehrere Spuren 
gleichzeitig zu selektieren.

So selektieren Sie eine Spur:

 Klicken Sie im Kanalzug einer nicht 
hervorgehobenen Spur auf deren Namen.

So selektieren Sie mehrere Spuren auf einmal:

1 Klicken Sie im Kanalzug einer nicht 
hervorgehobenen Spur auf deren Namen.

2 Klicken Sie bei gedrückter Umschalttaste auf 
eine weitere Schaltfläche.

Alle zwischen der ersten und der letzten 
ausgewählten Spur liegenden Spuren werden 
ebenfalls selektiert.

Führen Sie einen der folgenden Schritte aus, 
um Spuren zu selektieren oder zu deaktivieren, 
die nicht nebeneinander liegen:

 Klicken Sie bei gedrückter Befehls- (Mac) bzw. 
Strg-Taste (Windows) auf nicht markierte 
Spurnamen, um sie zu selektieren.

 Klicken Sie bei gedrückter Befehls- (Mac) bzw. 
Strg-Taste (Windows) auf markierte 
Spurnamen, um sie zu selektieren.

So nehmen Sie Selektionen über alle Spuren 
hinweg vor:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf einen nicht markierten 
Spurnamen.

So heben Sie die Selektion aller Spuren auf:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. Alt-
Taste (Windows) auf einen markierten Spurnamen.

Selektieren von Spuren beim Vornehmen 
von Edit-Selektionen

Mit Pro Tools ist es möglich, die Selektion von 
Spuren mit einer Edit-Selektion zu koppeln. Wenn 
Spur- und Edit-Selektionen gekoppelt werden, 
können Sie eine Selektion innerhalb einer Spur 
oder über mehrere Spuren hinweg zum Bearbeiten 
vornehmen. Dabei wird jede zugehörige Spur 
selektiert (Spurnamen werden automatisch 
hervorgehoben). 

So koppeln Sie Spur- und Edit-Selektion:

 Wählen Sie Options > Link Track and Edit 

Selection.

Scroll To Track-Dialogfeld

Selektierte und nicht selektierte Spuren

nicht ausgewählte Spur
ausgewählte Spur
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Scrollen einer Spur in die Ansicht

So scrollen Sie eine Spur in die Ansicht:

 Klicken Sie in der Tracks-Liste oder im Mix- bzw 
Edit-Fenster mit der rechten Maustaste auf den 
Spurnamen und wählen Sie Scroll into View.

Löschen von Spuren
Beim Löschen von Spuren bleiben die Daten der 
Audio- oder MIDI-Clips in der Clipliste erhalten; 
die Anordnung der Clips auf der gelöschten Spur 
(die Playlist der Spur) geht jedoch verloren. 

Enthält die Spur Playlists, die keiner Spur 
zugewiesen sind, werden Sie gefragt, ob Sie diese 
löschen oder beibehalten möchten.

So löschen Sie eine Spur:

1 Klicken Sie zum Auswählen der Spur im 
dazugehörigen Kanalzug auf den 
betreffenden Namen. 

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Delete.

• Klicken Sie in der Tracks-Liste oder im Mix- 
bzw Edit-Fenster mit der rechten Maustaste auf 
den Spurnamen und wählen Sie Delete.

3 Klicken Sie auf OK, um die ausgewählten 
Spuren aus der Session zu entfernen.

Duplizieren von Spuren
Mithilfe des Duplicate Track-Befehls können Sie 
von einer oder mehreren Spuren Duplikate 
erstellen. Diese enthalten sämtliche Audio- bzw. 
MIDI-Daten, die Playlists, Automationsdaten und 
anderen Eigenschaften der Originalspuren.

So duplizieren Sie eine oder mehrere Spuren:

1 Wählen Sie die Spuren, die Sie 
duplizieren möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Duplicate. 

• Drücken Sie Wahl + Umschalt + D (Mac) bzw. 
Alt + Umschalt + D (Windows).

• Klicken Sie mit der rechten Maustaste auf den 
Spurnamen in der Tracks-Liste oder im Edit- 
oder Mix-Fenster und wählen Sie Duplicate.

3 Legen Sie im Duplicate Tracks-Dialogfeld die 
folgenden Optionen fest:

• Geben Sie die gewünschte Kopienanzahl in das 
Number of Duplicates-Feld ein. 

• Soll die momentan aktive (sichtbare) Edit-
Playlist aus der Ausgangsspur übernommen 
werden, aktivieren Sie Active Playlist. 

Der Delete Track-Befehl kann nicht 
rückgängig gemacht werden.

Um mehrere Spuren zu selektieren, klicken 
Sie bei gedrückter Befehls- (Mac) bzw. Strg-
Taste (Windows) auf die entsprechenden 
Spurnamen.

Um mehrere Spuren zu selektieren, klicken 
Sie bei gedrückter Umschalttaste auf die 
Namen der gewünschten Spuren.

Informationen dazu finden Sie unter 
„Selektieren von Spuren“ auf Seite 223.

Duplicate Tracks-Dialogfeld
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• Um alle Edit-Playlists der Ausgangsspur zu 
kopieren, aktivieren Sie Alternate Playlists.

• Sollen alle Automationsdaten der Ausgangsspur 
kopiert werden, aktivieren Sie Automation. 

• Sollen alle Plug-In- und Insert-Zuweisungen 
kopiert werden, aktivieren Sie Inserts. 

• Sollen alle Sends und Send-Zuweisungen 
kopiert werden, aktivieren Sie Sends.

• Sollen alle Mix- und Edit-Gruppen-
Zuweisungen erhalten bleiben, aktivieren Sie 
Group Assignments. 

4 Beim Duplizieren mehrerer Spuren haben Sie 
folgende Möglichkeiten:

• Wenn alle neu erstellten Spuren nach der letzten 
selektierten Ausgangsspur (ganz rechts im Mix-
Fenster bzw. ganz unten im Edit-Fenster) 
angezeigt werden sollen, aktivieren Sie die Insert 

after Last Selected Track-Option.

• Sollen die einzelnen neu erstellten Spuren direkt 
nach der jeweils dazugehörigen Ausgangsspur 
eingefügt werden, deaktivieren Sie die Insert 
after Last Selected Track-Option.

5 Klicken Sie auf OK, um die Spuren unter 
Verwendung der Einstellungen im Duplicate 
Tracks-Dialogfeld zu duplizieren. Klicken Sie 
auf Cancel, um das Dialogfeld zu schließen, 
ohne Spuren zu duplizieren. 

Duplizieren von VCA Slave-Spuren
(Nur Pro Tools HD)

Durch das Duplizieren einer VCA Slave-Spur ohne 
Duplizieren ihrer Gruppenzuweisungen wird die 
Automation auf der duplizierten Spur addiert. 
Die Wiedergabe des addierten Duplikats erfolgt 
genauso wie in der VCA-Gruppe. Weitere 
Informationen finden Sie unter „VCA Master-
Spuren“ auf Seite 985.

Spurdarstellungen
Die Spurdarstellung bestimmt, welche Daten im 
Bereich der Playlist angezeigt und editiert werden. 
Als Spurdarstellung kann „Playlists“, „Blocks“, 
„Analysis“, „Warp“, „Waveform“, „Volume“, 
„Volume Trim“, „Mute“, „Pan“, „Send“, ein 
automatisierter Parameter oder ein Continous 
Controller ausgewählt werden, abhängig von der 
Spurart und Ihrem Pro Tools-System.

Audiospuren. – können auf Blocks, Playlists, 
Analysis, Warp, Waveform, Volume, Volume Trim, 
Mute, Pan, Send-Steuerelemente oder auf 
beliebige, für die Automatisierung aktivierte Plug-
In-Parameter gesetzt werden. In der Regel werden 
Audiospuren als Wellenform dargestellt. Im 
Waveform-Format wird die Amplitude des 
Spurmaterials grafisch dargestellt (zeitbezogene 
Darstellung von Ton). Diese Spurdarstellung 
bietet die notwendigen Informationen für wichtige 
Editiervorgänge in Clips.

Auxiliary-Eingangs-Spuren. – können auf Volume, 
Volume Trim, Mute, Pan, Send-Steuerelemente oder 
auf beliebige, für die Automatisierung aktivierte 
Plug-In-Steuerelemente gesetzt werden. 

Master-Fader-Spuren. – können auf Volume, 
Volume Trim oder für die Automatisierung aktivierte 
Plug-In-Steuerelemente gesetzt werden.

VCA Master-Spuren (nur Pro Tools HD). – können 
auf Volume, Volume Trim oder Mute gesetzt werden.

MIDI-Spuren. – können auf Blocks, Clips, Notes, 
Velocity, Volume, Mute, Pan, Pitch Bend, Mono After 

Touch, Program Change, Sysex und beliebige 
Continuous Controller gesetzt werden. MIDI-Spuren 
werden im Allgemeinen auf Notes oder Clips gesetzt, 
sodass Noten im „Pianorollenformat“ angezeigt 
werden. Verwenden Sie die Clip-Darstellung zum 
Editieren und Anordnen von MIDI-Clips. 
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Verwenden Sie die Notendarstellung zum 
Einfügen und Editieren von MIDI-Noten. Andere 
MIDI-Spurdarstellungen sind nützlich, um 
Velocity, Controller-Daten, 
Programmwechselbefehle oder Sysex-Events zu 
editieren.

Instrumentenspuren. – können auf folgende 
Einstellungen gesetzt werden: Blocks, Clips, Notes, 
Velocity, Volume, Mute, Pan, Pitch Bend, Mono 

After Touch, Program Change, Sysex und alle 
Continuous Controller für MIDI sowie Volume, 
Volume Trim, Mute, Pan, Send-Steuerelemente 
oder für die Automatisierung aktivierte Plug-In-
Steuerelemente. Instrumentenspuren werden im 
Allgemeinen auf Notes oder Clips gesetzt, sodass 
Noten im „Pianorollenformat“ angezeigt werden. 
Verwenden Sie die Notendarstellung, um MIDI-
Noten einzufügen, zu editieren, zu kopieren und 
einzufügen. Verwenden Sie die Clip-Darstellung 
zum Anordnen, Erfassen und Zusammenfügen von 
Clips. Andere Instrumentenspur-Darstellungen 
sind nützlich, um Automation, Controller-Daten, 
Programmwechselbefehle oder Sysex-Events zu 
editieren.

Videospuren. – Informationen zu 
Videospurdarstellungen finden Sie unter 
„Videospurdarstellung“ auf Seite 1264.

Blocks-Darstellung
Ist das Darstellungsformat einer Spur auf Blocks 
eingestellt, werden Audio- und MIDI-Clips als 
leere Blöcke mit lediglich dem Clipnamen 
dargestellt. Diese Spurdarstellung ist dann 
sinnvoll, wenn Sie mit dem Erfassen und Editieren 
von Clips in der Wellenform- oder in der MIDI 
Event-Darstellung fertig sind und diese nun noch 
verschieben und anordnen möchten. Die 
Aktualisierung des Bildschirms erfolgt mit diesem 
Darstellungsformat am schnellsten.

Playlists-Darstellung
(Nur Audiospuren)

Wenn das Darstellungsformat einer Spur auf 
Playlists eingestellt ist, werden alternative Playlists 
für Audiospuren in Playlist-Lanes unterhalb der 
Haupt-Playlist auf der Spur angezeigt. Diese 
Darstellung ist nützlich für die 
Spurzusammenstellung. Sie können die besten 
Stücke aus den alternativen Playlists der Spur 
auswählen und sie in die Haupt-Playlist kopieren.

Analysis- und Warp-Darstellung
(Nur Audiospuren)

Wenn das Darstellungsformat einer Spur auf 
Analysis oder Warp eingestellt ist, können Sie die 
Elastic Audio-Analyse- und Warp-Marker auf 
Spuren mit aktiviertem Elastic Audio anwenden.

Waveform-Darstellung
(Nur Audio)

Wenn das Darstellungsformat einer Spur auf 
Waveform eingestellt ist, können Sie Audioclips 
auf Audiospuren editieren und anordnen. 
Wellenformen sind zeitbezogene Darstellungen 
der Audiodaten. Sie können als normale oder 
gleichgerichtete Wellenformen angezeigt und im 
Peak- oder Power-Modus berechnet werden.

Darstellung einer Audiospur in der Waveform-Einstellung

Bei Audiospuren wird die Wellenform auch 
in Playlists-, Analysis-, Warp- und 
Automation-Darstellungen angezeigt.
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Clip-Darstellung
(Nur MIDI)

Wenn das Darstellungsformat einer Spur auf Clips 
eingestellt ist, können Sie MIDI-Clips auf MIDI- und 
Instrumentenspuren editieren und anordnen.

Notendarstellung
(Nur MIDI)

Wenn das Darstellungsformat einer Spur auf Notes 
eingestellt ist, können Sie MIDI-Noten auf MIDI- 
und Instrumentenspuren einfügen und editieren.

Automation- und Controller-
Darstellungen
Wird eine Audio- oder Instrumentenspur im Format 
Volume, Pan oder mit der Einstellung eines anderen 
automatisierten Parameters angezeigt oder eine MIDI- 
oder Instrumentenspur auf einen Continuous 
Controller-Typ (Volume, Pitch Bend) eingestellt, 
werden die Daten für diese Spur in Form einer geraden 
Linie mit Breakpoints dargestellt, die Sie editieren 
können. Um Automationsdaten zu ändern, können Sie 
Breakpoints an eine andere Stelle ziehen. Neue 
Breakpoints werden mit dem Pencil-Tool oder 
Grabber-Tool eingefügt. MIDI- oder 
Instrumentenspuren liefern auch eine Velocity-
Darstellung für das Editieren von MIDI-
Velocity-Werten.

Darstellung einer MIDI-Spur in der Clips-Einstellung

Darstellung einer Audiospur in der Pan-Einstellung

Weitere Informationen zum Einfügen und 
Editieren von Controller-Daten für MIDI-
Spuren finden Sie unter „Continuous 
Controller-Events“ auf Seite 712.

Sie können auch Automations- und 
Controller-Daten in Lanes unterhalb der 
Haupt-Playlist-Darstellung editieren. 
Weitere Informationen zum Editieren von 
Automationsdaten für Audiospuren finden Sie 
unter Kapitel 45: „Automation“. 
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Einstellen der Spurdarstellung 
im Edit-Fenster
So stellen Sie das Darstellungsformat einer Spur ein:

 Wählen Sie im Track View-Selektor die 
gewünschte Spur und im Popup-Menü das 
Darstellungsformat.

Die Spur wird im neuen Format angezeigt. Gehört 
die Spur zu einer aktiven Edit-Gruppe, werden alle 
Spuren dieser Gruppe im neuen Format angezeigt.

Audio Track View-Selektor

Auxiliary Track View-Selektor

Master Fader Track View-Selektor

VCA Master Track View-Selektor (nur Pro Tools HD)

MIDI Track View-Selektor

Instrument Track View-Selektor
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Ändern der Spurdarstellung
Bei Audio-, Auxiliary-Eingangs-, MIDI- und 
Instrumentenspuren können Sie zur nächsten oder 
vorhergehenden Spurdarstellung oder zwischen 
vordefinierten gängigen Darstellungen wechseln.

Wechseln zur vorherigen oder nächsten 
Spurdarstellung

Beim Wechseln zur nächsten oder vorherigen 
Spurdarstellung entspricht die Reihenfolge der 
Darstellungsformate der Anordnung im Track 
View-Selektor.

So wechseln Sie zum vorhergehenden oder 
nächsten Darstellungsformat:

1 Klicken Sie auf die Spur, deren Darstellung Sie 
ändern möchten. Um Darstellungen für mehrere 
Spuren zu ändern, klicken Sie mit gedrückter 
Umschalttaste oder ziehen Sie das Selector-Tool, 
um zusätzliche Spuren auszuwählen oder wählen 
Sie eine Gruppe aus.

2 Sie haben folgende Möglichkeiten:

• Um auf allen ausgewählten Spuren zum 
vorhergehenden oder nächsten 
Darstellungsformat zu wechseln, drücken Sie 
Ctrl + Befehl (Mac) bzw. Strg + Windows 
(Windows) sowie die Nach-links- bzw. Nach-
rechts-Pfeiltaste.

• Um auf allen Spuren zum vorhergehenden oder 
nächsten Darstellungsformat zu wechseln, 
drücken Sie Befehl + Wahl + Ctrl (Mac) bzw. 
Strg + Windows (Windows) sowie die Nach-
links- bzw. Nach-rechts-Pfeiltaste.

Wechseln zwischen gängigen Spurdarstellungen

Die gängigsten Darstellungsformate zum Editieren 
von Audiospuren sind „Waveform“ und „Volume“. 
Die gängigsten Darstellungsformate zum Editieren 
von MIDI- und Instrumentenspuren sind „Notes“ 
und „Clips“. Das Wechseln zwischen diesen 
Darstellungen ist in Pro Tools sehr einfach.

So schalten Sie zwischen Darstellungsformaten 
auf Spuren um, die den Edit-Cursor (oder eine 
Edit-Selektion) enthalten:

1 Klicken Sie auf die Spur, deren Darstellung Sie 
ändern möchten. Um die Darstellung mehrerer 
Spuren zu ändern, klicken Sie bei gedrückter 
Umschalttaste auf die zusätzlichen Spuren oder 
ziehen das Selector-Tool über die zusätzlichen 
Spuren.

2 Sie haben folgende Möglichkeiten:

• Halten Sie die Windows- (Windows) bzw. Ctrl-
Taste (Mac) gedrückt und drücken Sie die 
Minustaste auf der alphanumerischen Tastatur.

• Drücken Sie bei aktiviertem Befehls-
Tastaturfokus (siehe „Tastaturfokus“ auf 
Seite 27) auf die Minus-Taste der 
alphanumerischen Tastatur.

Für Spurdarstellungen am Anfang der Liste 
(beispielsweise „Blocks“ für Audio- oder 
MIDI-Spuren) ist der Wechsel zur 
vorhergehenden Spurdarstellung nicht 
verfügbar. Für Spurdarstellungen am Ende 
der Liste (beispielsweise eine MIDI-
Controller-Option) ist der Wechsel zur 
nächsten Spurdarstellung nicht verfügbar.

Um die Darstellung für alle Spuren zu 
ändern, drücken Sie Wahl + Ctrl + 
Minuszeichen (–) (Mac) bzw. Alt + 
Windows + Minuszeichen (–) (Windows) auf 
der alphanumerischen Tastatur.

Um die Darstellung für alle Spuren mit 
aktiviertem Befehls-Tastaturfokus 
umzuschalten, drücken Sie Wahl + 
Minuszeichen (–) (Mac) bzw. Alt + 
Minuszeichen (–) (Windows) auf der 
alphanumerischen Tastatur.
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Bei Audiospuren erfolgt ein Wechsel zwischen 
den Darstellungen „Waveform“ und „Volume“. 
Bei MIDI- und Instrumentenspuren wird zwischen 
den Darstellungen „Notes“ und „Clips“ 
gewechselt.

Master-Darstellungsformate für 
Spuren
Audio-, MIDI- und Instrumentenspuren verfügen 
über Darstellungsformate, die als Master agieren. 
Wenn eine Spur in der Master-Darstellung 
angezeigt wird, werden alle darauf angewendeten 
Bearbeitungsschritte von den anderen Daten in der 
Spur übernommen. Wird beispielsweise das 
Darstellungsformat einer Audiospur auf 
„Waveform“ eingestellt, werden beim Kopieren 
und Einfügen nicht nur die Wellenformdaten, 
sondern auch alle Automationsdaten entsprechend 
bearbeitet. 

Das Master-Darstellungsformat basiert 
folgendermaßen auf der Art der Spur:

• Audiospuren: „Waveform“ und „Blocks“

• MIDI- und Instrumentenspuren: „Clips“, 
„Blocks“ und „Notes“ (wenn Sie das Selector-
Tool verwenden)

Darstellungshöhe von Spuren
Spuren können im Edit-Fenster mit einer von acht 
Höhen dargestellt werden: Micro, Mini, Small, 
Medium, Large, Jumbo, Extreme und Fit To 

Window. Größere Darstellungshöhen ermöglichen 
ein präzises Editieren, besonders für MIDI. 
Kleinere Darstellungshöhen dienen der besseren 
Übersicht auf dem Bildschirm in einer großen 
Session.

Sie können die Darstellungshöhe für jede Spur 
einzeln einstellen oder für alle Spuren dieselbe 
Höhe wählen. Dies ist auch während der 
Wiedergabe möglich.

Sie haben folgende Möglichkeiten, um die 
Spurhöhe festzulegen:

 Klicken Sie auf den kleinen Pfeil direkt neben 
Spurnamen, um das Track Height-Popup-Menü 
einzublenden.

 Klicken Sie mit der rechten Maustaste auf die 
vertikale Zoom-Skala rechts neben den Spur-
Steuerelementen und wählen Sie im Popup-
Menü die Höhe aus.

Die Spur wird in der neuen Einstellung angezeigt. 
Gehört die Spur zu einer Edit-Gruppe, werden alle 
Spuren dieser Gruppe in der neuen Höhe 
angezeigt.

So ändern Sie die Größe aller Spuren proportional:

 Klicken Sie im Edit-Fenster auf die 
Schaltfläche für das vertikale Zoomen.

Track Height-Popup-Menü 

Halten Sie die ctrl-Taste (Mac) bzw. Windows-
Taste (Windows) gedrückt und verwenden Sie 
die Nach-oben- und Nach-unten-Pfeiltasten, 
um die Darstellungshöhe einer beliebigen Spur 
zu verändern, die eine Selektion oder den Edit-
Cursor enthält.

Schaltflächen für das vertikale Vergrößern und 
Verkleinern, Edit-Fenster
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Kontinuierlich variable Spurhöhe
Im Edit-Fenster können Sie die Darstellungshöhe 
jeder Spur kontinuierlich in der Größe anpassen, 
indem Sie den unteren Rand der Spalte mit den Spur-
Steuerelementen ziehen. 

So ändern Sie die Darstellungshöhe von Spuren 
im Edit-Fenster:

 Ziehen Sie den unteren Rand der Spalte mit den 
Spur-Steuerelementen einer beliebigen Spur mit 
dem Cursor nach oben oder unten. Die Cursor-
Darstellung ändert sich und zeigt an, dass Sie die 
Größe der Spur verändern können.

Die Darstellungshöhe der Spur ändert sich 
schrittweise.

Spur-Steuerelemente und -
Darstellungshöhe
Die Darstellungshöhe der Spuren beeinflusst die 
Art und Weise, wie die verschiedenen Spur-
Steuerelemente im Edit-Fenster angezeigt werden. 
Wenn beispielsweise die Darstellungshöhe für 
eine Spur auf „Small“ eingestellt ist, werden die 
meisten Schaltflächen kleiner dargestellt.

Bei der Darstellungshöhe Mini oder Micro sind nur 
die Record-, Solo- und Mute-Steuerelemente zu 
sehen; auf die Menüs Playlist, Track Timebase, 
Track Height und Track View können Sie über 
denselben Selektor zugreifen.

Ist die Darstellungshöhe der Spur auf Medium, 
Large, Jumbo oder Extreme eingestellt, werden 
alle Spur-Steuerelemente in ihrer Originalgröße 
angezeigt.

Anpassen der Darstellungshöhe einer Audiospur

Halten Sie die Befehls- (Mac) bzw. Strg-
Taste (Windows) gedrückt, um die 
Darstellungshöhe kontinuierlich und ohne 
Zwischenschritte anzupassen.

Um alle Spuren kontinuierlich anzupassen, 
halten Sie die Wahl- (Mac) bzw. Alt-Taste 
(Windows) beim Ziehen gedrückt.

Um alle ausgewählten Spuren kontinuierlich 
anzupassen, halten Sie die Wahl- (Mac) bzw. 
Alt-Taste (Windows) und die Umschalttaste 
beim Ziehen gedrückt.

Darstellungshöhe der Spur in der Small-Einstellung

Darstellungshöhe der Spur in der Mini-Einstellung

Darstellungshöhe der Spur in der Large-Einstellung



Pro Tools-Referenzhandbuch232

Tracks-Liste
Die Tracks-Liste (auf der linken Seite des Mix- 
und Edit-Fensters) enthält alle Spuren der Session. 
Sie ermöglicht das Ein- und Ausblenden von 
Spuren in den Mix-, Edit-, MIDI Editor- und Score 
Editor-Fenstern. Auch wenn eine Spur 
ausgeblendet ist, wird das Material der Spur als 
Teil der Session abgespielt. Nicht aktive Spuren 
werden in der Tracks-Liste kursiv dargestellt.

Einblenden/Ausblenden der 
Tracks-Liste und Groups-Liste

Führen Sie einen der folgenden Schritte aus, um 
die Tracks-Liste (und Groups-Liste) ein- oder 
auszublenden:

 Aktivieren (oder deaktivieren) Sie im Menü des 
Edit-Fensters Track List.

 Klicken Sie im Mix- oder Edit-Fenster auf die 
Schaltfläche für das Anzeigen/Ausblenden der 
Tracks-Liste/Groups-Liste.

Menü der Tracks-Liste
Das Popup-Menü oberhalb der Tracks-Liste bietet 
Befehle, mit denen Sie entweder alle Spuren, nur 
die aktuell auf dem Bildschirm ausgewählten 
Spuren oder nur bestimmte Arten von Spuren 
(Audio, Auxiliary-Eingang, Master-Fader, MIDI, 
Instrument, VCA Master oder inaktive Spuren) 
ein- oder ausblenden können. 

Mithilfe der Tracks-Liste können Sie auch 
neue Spuren erstellen, wenn Medien per 
Drag & Drop aus einem Workspace-Browser 
importiert werden. Siehe „Importieren von 
Dateien per Drag & Drop“ auf Seite 329. 

Spurenliste

Spurname

Spurartsymbol

Farbliche Kennzeichnung

Ein-/Ausblenden von Spuren

Menü der Tracks-Liste

Edit-Fenster: Anzeigen/Ausblenden der Tracks-
Liste/Groups-Liste

Show Only-Option
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Mithilfe des Sort Tracks By-Befehls können Sie die 
Spuren nach Name, Type, Edit Group, Mix Group 
oder Voice sortieren. Die Sortierreihenfolge wird in 
der Tracks-Liste im Mix-, Edit-, MIDI Editor- und 
Score Editor-Fenster übernommen. 

Wenn eine einer aktiven Gruppe zugehörige Spur 
ausgeblendet ist, wirken sich Editiervorgänge, die im 
Edit-Fenster an den anderen Mitgliedern der Gruppe 
vorgenommen werden, nicht auf die ausgeblendete 
Spur aus. Im Mix-Fenster hingegen wirken sich alle 
Vorgänge mit Ausnahme der Scharfschaltung auf 
eine einer aktiven Gruppe zugehörige ausgeblendete 
Spur aus.

Die Optionen im Menü der Tracks-Liste im Score-
Editor-Fenster unterscheiden sich von denen im 
Mix-, Edit- und MIDI Editor-Fenster. Weitere 
Informationen finden Sie unter „Track List“ auf 
Seite 762.

Ein- und Ausblenden von Spuren
Die Mix- und Edit-Fenster sind im Hinblick darauf 
verknüpft, welche Spuren ein- bzw. ausgeblendet 
sind. Das Score Editor- und MIDI Editor-Fenster 
sind jedoch völlig eigenständig in der Festlegung, 
welche Spuren ein- bzw. ausgeblendet sind. So 
wird beispielsweise eine im Edit-Fenster 
ausgeblendete Spur auch im Mix-Fenster 
ausgeblendet, nicht jedoch im Score Editor- oder 
MIDI Editor-Fenster. Außerdem wird durch das 
Ausblenden einer bestimmten Spur in einem MIDI 
Editor-Fenster diese nur in diesem MIDI Editor-
Fenster ausgeblendet.

Zum Ausblenden einer Spur wählen Sie eine der 
folgenden Methoden:

 Klicken Sie auf das Symbol für das Ein-/ 
Ausblenden der Spur in der Tracks-Liste

 Klicken Sie in der Tracks-Liste (oder im Spur-
Kanalzug) mit der rechten Maustaste auf den 
Spurnamen und wählen Sie Hide (oder Hide and 
Make Inactive, wenn die Spur aktiv ist und Sie sie 
auch deaktivieren möchten).

Zum Einblenden einer momentan ausgeblendeten 
Spur wählen Sie eine der folgenden Methoden:

 Klicken Sie auf das Symbol für das Ein-/ 
Ausblenden der Spur in der Tracks-Liste

 Klicken Sie in der Tracks-Liste (oder im Spur-
Kanalzug) mit der rechten Maustaste auf den 
Spurnamen und wählen Sie Show (oder Show and 
Make Active, wenn die Spur inaktiv ist und Sie sie 
auch aktivieren möchten).

So blenden Sie alle Spuren ein:

 Wählen Sie im Menü der Tracks-Liste Show All 

Tracks.

Sort Tracks By-Optionen

Symbol für eine angezeigte Spur in der Tracks-Liste

Symbol für eine ausgeblendete Spur in der Tracks-Liste

Sie können dazu auch bei gedrückter Wahl- 
(Mac) bzw. Alt-Taste (Windows) auf das Ein-/ 
Ausblenden-Symbol einer ausgeblendeten 
Spur klicken.
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So blenden Sie alle Spuren aus:

 Wählen Sie im Menü der Tracks-Liste Hide 
All Tracks.

So blenden Sie mehrere Spuren auf einmal ein:

1 Selektieren Sie einen Bereich ausgeblendeter 
Spuren in der Tracks-Liste.

2 Klicken Sie oben in der Tracks-Liste auf das 
Symbol für das Ein-/Ausblenden 
ausgeblendeter Spuren.

3 Klicken Sie mit gedrückter Umschalttaste unten 
in der Auswahl auf das Symbol für das Ein-/ 
Ausblenden ausgeblendeter Spuren.

Alle zwischen der ersten und der letzten 
ausgewählten Spur liegenden Spuren werden 
ebenfalls selektiert.

So blenden Sie mehrere Spuren in der Tracks-Liste 
mithilfe des Fadenkreuzes ein oder aus:

1 Bewegen Sie den Cursor links neben den Namen 
einer Spur, bis das Fadenkreuzsymbol mit einem 
kleinen Pluszeichen (+) angezeigt wird.

2 Klicken Sie in der Liste auf die Spur und ziehen 
Sie den Cursor nach oben oder nach unten über die 
Ein-/Ausblenden-Symbole, um die erste Spur und 
die direkt darüber oder darunter liegenden Spuren 
ein- oder auszublenden.

So blenden Sie mehrere Spuren, die nicht 
nebeneinander liegen, ein oder aus:

 Klicken Sie für die Spuren, die Sie ein- oder 
ausblenden möchten, auf das Ein-/Ausblenden-
Symbol.

So stellen Sie zuvor angezeigte Spuren wieder her, 
nachdem Sie die Befehle „Show All Tracks“, 
„Show Only Selected Tracks“, oder „Show Only 
Tracks by <Spurtyp>“ verwendet haben:

 Wählen Sie im Menü der Tracks-Liste die 
Restore Previously Shown Tracks-Option

Mix/Edit-Gruppen und 
ausgeblendete Spuren
Sollte im Mix-Fenster eine ausgeblendete Spur einer 
aktivierten Gruppe angehören, so haben alle 
Vorgänge im Mix-Fenster, die auf andere Mitglieder 
der Gruppe angewendet werden, auch Auswirkungen 
auf die ausgeblendete Spur. Dies gilt allerdings nicht 
für das Scharfschalten für die Audio- oder MIDI-
Aufnahme. Wenn Sie eine gruppierte Spur solo- oder 
stummschalten oder sie für die Aufzeichnung von 
Automationsdaten aktivieren, werden alle diese 
Vorgänge auch auf die ausgeblendeten Mitglieder 
der Gruppe angewendet. 

Im Edit-Fenster dagegen haben auf Mitglieder einer 
aktivierten Gruppe angewendete Editiervorgänge 
keine Auswirkungen auf ausgeblendete Spuren, die 
ebenfalls zu dieser Gruppe gehören. 

Spurnummern und 
ausgeblendete Spuren
Im Mix- und im Edit-Fenster können ausgeblendete 
Spuren in der Nummerierungsreihenfolge der Spur-
Positionsnummern entweder eingeschlossen oder 
ignoriert werden:

• Wenn Track Position Numbers Stay with Hidden 

Tracks in den Display-Voreinstellungen 
deaktiviert wurde, werden nur den momentan 
angezeigten Spuren Nummern zugewiesen. Die 
aktiven Spuren werden dann durchnummeriert. 
Ausgeblendete Spuren sind nicht nummeriert.

• Wenn Track Position Numbers Stay with Hidden 

Tracks in den Display-Voreinstellungen aktiviert 
wurde, bleiben die Positionsnummern der Spuren 
erhalten, auch wenn diese ausgeblendet sind.

Sie können dazu auch bei gedrückter Wahl- 
(Mac) bzw. Alt-Taste (Windows) auf das Ein-/ 
Ausblenden-Symbol einer eingeblendeten 
Spur klicken.

Um Spuren auf dem Bildschirm neu 
anzuordnen, ziehen Sie die Spurnamen in der 
Tracks-Liste oder im Mix- oder Edit-Fenster 
an die neue Position.
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Kontextmenü für Spurnamen
(Mix-Fenster, Edit-Fenster, MIDI Editor-Fenster 
oder Tracks-Liste)

Wenn Sie mit der rechten Maustaste im Mix-
Fenster, Edit-Fenster, MIDI Editor-Fenster oder in 
der Tracks-Liste auf einen Spurnamen klicken, 
wird ein Kontextmenü mit den folgenden Befehlen 
geöffnet:

Hide/Show. – blendet die Spur (oder ggf. die 
ausgewählten Spuren) aus bzw. ein.

Hide and Make Inactive. – blendet die Spur (oder 
ggf. die ausgewählten Spuren) aus und deaktiviert 
sie.

Make Active/Inactive. – schaltet den 
Aktivitätsstatus der Spur um (bzw. im Mix- oder 
Edit-Fenster den Aktivitätsstatus aller 
ausgewählten Spuren).

Scroll Into View. – scrollt die Spur im Edit-Fenster 
nach oben bzw. im Mix-Fenster nach links.

Export MIDI (nur MIDI- und Instrumentenspuren). 

– exportiert die MIDI-Daten aus einer oder mehreren 
MIDI- oder Instrumentenspuren in eine Standard-
MIDI-Datei. Weitere Informationen finden Sie unter 
„Exportieren von MIDI-Dateien“ auf Seite 344.

Coalesce VCA Master Automation (nur VCA 
Master-Spuren mit Pro Tools HD). – addiert die 
VCA-Automation mit den Slave-Spuren des VCA.

Coalesce Trim Automation (nur Pro Tools HD). – 
addiert die Trim-Automation auf der Spur (oder 
ggf. den ausgewählten Spuren).

Clear Trim Automation (nur Pro Tools HD). – 
löscht die Trim-Automation auf der Spur (oder 
ggf. den ausgewählten Spuren).

Locked (nur Videospur). – schaltet den Gesperrt-/ 
Entsperrt-Status der Videospur um (oder ggf. der 
ausgewählten Videospuren).

New. – öffnet das New Track-Dialogfeld.

Rename. – öffnet das Track Name-Dialogfeld.

Duplicate. – dupliziert die Spur (oder ggf. die 
ausgewählten Spuren).

Split Into Mono (nur Mehrkanalspuren). – teilt 
eine Mehrkanalspur (oder ggf. die ausgewählten 
Mehrkanalspuren) in ihre einzelnen 
Monokomponenten-Spuren auf.

Delete. – löscht die Spur (oder ggf. die 
ausgewählten Spuren).

Field Recorder Guide Track (nur Audiospuren in 
Pro Tools HD). – legt die ausgewählte Spur als 
Führungsspur für Workflows mit tragbaren 
Rekordern fest.

MIDI Real-Time Properties (nur MIDI- und 
Instrumentenspuren). – öffnet das Real-Time 
Properties-Fenster für die Spur. 

Open in New MIDI Editor (nur MIDI- und 
Instrumentenspuren). – öffnet die Spur in einem 
neuen MIDI Editor-Fenster. 

Open in Score Editor (nur MIDI- und 
Instrumentenspuren). – öffnet die Spur im Score 
Editor-Fenster.

Open in MIDI Event List (nur MIDI- und 
Instrumentenspuren). – öffnet die Spur in der 
MIDI Event-Liste.

Notation Display Track Settings (nur MIDI- und 
Instrumentenspuren). – öffnet das Fenster für die 
Spureneinstellungen in der Notationsdarstellung. 
Die Notenschrift kann nur in Score Editor- oder 
MIDI Editor-Fenstern angezeigt werden, für die 
die Notationsdarstellung eingestellt wurde.

Expand Channels to New Tracks. – erweitert 
Mehrkanal-Audiodateien, die aus einem 
transportablen Rekorder importiert wurden, auf neue 
Spuren, sodass jeder Kanal auf seiner eigenen Mono-
Audiospur platziert ist. Pro Tools passt auch 
automatisch alle erweiterten Spuren an die Edits in 
der Führungsspur (der erweiterten Spur) an. Sie 
können Mehrkanal-Dateien auf neue Spuren 
erweitern, die nach Kanalname, Kanalnummer, 
Kanalname und -nummer oder nur nach Timecode 
angeordnet sind.
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Zuweisen von Audio-Ein- und 
Ausgängen an Spuren
Eingänge für Audio-, Auxiliary-Eingangs- und 
Instrumentenspuren können Kanälen von Audio-
Interfaces oder internen Bussen zugewiesen werden. 
Ausgänge für Audio-, Auxiliary-Eingangs-, Master-
Fader- und Instrumentenspuren können ebenfalls 
Kanälen von Audio-Interfaces oder internen Bussen 
zugewiesen werden.

Bei Stereo- und Mehrkanal-Surround-Spuren werden 
die Eingänge und Ausgänge als Stereopaare und in 
Mehrkanalgruppen dargestellt. Die verfügbaren 
Eingänge, Ausgänge und Busse werden im I/O 
Setup-Dialogfeld als Pfade definiert (siehe Kapitel 7: 
„I/O-Setup“). 

Automatische Zuweisung von 
Ein- und Ausgängen
Wenn einer Session neue Spuren hinzugefügt 
werden, werden die Eingänge automatisch in 
aufsteigender Reihenfolge zugewiesen. Wenn Sie 
beispielsweise ein Audio-Interface mit acht 
Eingängen angeschlossen haben, werden bei der 
Erstellung von vier neuen Mono-Audiospuren 
automatisch vier Audiospuren hinzugefügt, deren 
Eingänge den ersten vier im I/O Setup-Dialogfeld 
festgelegten Pfaden zugewiesen werden. Beim 
Erstellen von Stereospuren werden die Eingänge 
automatisch aufeinanderfolgenden 
Eingangspaaren zugewiesen.

Die automatische Zuweisung von Ausgängen zu 
neuen Spuren ist von dem im I/O Setup-Dialogfeld 
definierten Standardausgang (New Track Default 

Output Bus) abhängig.

Zuweisen von Eingängen 
an Audioeingänge
(Audio-, Auxiliary-Eingangs- und 
Instrumentenspuren)

So weisen Sie einen Audioeingang einer Audio-, 
Auxiliary-Eingangs- oder Instrumentenspuren zu:

1 Um Audiospureingänge im Edit-Fenster 
zuzuweisen, wählen Sie View > Edit Window > I/O.

2 Klicken Sie im Mix- oder Edit-Fenster auf den 
Input Path-Selektor der betreffenden Spur und 
treffen Sie Ihre Auswahl unter den verfügbaren 
Kanälen des Audio-Interface und den Bussen. 
Für Stereo- und Mehrkanal-Surround-Spuren 
stehen Eingänge als Paare und 
Mehrkanalgruppen zur Verfügung.

Mithilfe des Input Path-Selektors können Sie einen 
beliebigen Audioeingang bzw. einen der internen 
Pro Tools-Busse auf eine Audio-, Auxiliary-
Eingangs- oder Instrumentenspur routen. Die in 
diesem Popup-Menü verfügbaren Optionen 
werden durch die Eingangspfad-Konfiguration im 
I/O Setup-Dialogfeld festgelegt. Von anderen 
Spuren verwendete Eingänge erscheinen im 
Popup-Menü des Input Path-Selektors in 
Fettschrift.

Eingangs- und Ausgangszuweisungen für drei Mono-
Audiospuren

Auf Audio 2 
eingestellter 

Spureneingang

Auf Bus 2 
eingestellter 

Spureneingang

Spur, für die kein 
Eingang eingestellt ist

Instrumentenspuren weisen automatisch den 
Audioausgang eines Instrumenten-Plug-Ins zu, 
das auf der Spur eingefügt wurde.



Kapitel 13: Spuren 237

So weisen Sie automatisch alle Spureingänge 
(desselben Typs und mit derselben Kanalanzahl) 
eindeutigen aufsteigenden Eingangspfaden 
zu (kaskadierend):

 Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) bzw. Strg- und Alt-Taste 
(Windows) auf den Input Path-Selektor der am 
weitesten links gelegenen Spur und wählen Sie 
den ersten Eingangspfad (Mono oder Stereo, 
abhängig davon, ob Ihre Spuren Mono- oder 
Stereospuren sind). 

Alle sichtbaren Spuren mit derselben Kanalanzahl 
(Mono oder Stereo) werden automatisch eindeutigen 
Eingangspfadzuweisungen in aufsteigender 
Reihenfolge zugewiesen. Beispiel: Spur 1 wird A1 
zugewiesen, Spur 2 A2, Spur 3 A3 und so weiter.

So entfernen Sie eine Eingangszuweisung:

 Wählen Sie im Input Path-Selektor No Input aus.

Zuweisen von Audioausgängen
(Audio-, Auxiliary-Eingangs-, Master-Fader- 
und Instrumentenspuren)

So weisen Sie einen Audioausgang einer Audio-, 
Auxiliary-Eingangs-, Master-Fader- oder 
Instrumentenspur zu:

1 Um Audiospurausgänge im Edit-Fenster 
zuzuweisen, wählen Sie View > Edit 

Window > I/O.

2 Klicken Sie im Mix- oder Edit-Fenster auf den 
Output Path-Selektor der betreffenden Spur und 
treffen Sie Ihre Auswahl unter den verfügbaren 
Kanälen des Audio-Interface und den Bussen. 
Für Stereo- und Mehrkanal-Surround-Spuren 
stehen Ausgänge als Paare und 
Mehrkanalgruppen zur Verfügung.

Mithilfe des Output Path-Selektors können Sie 
eine Spur auf einen beliebigen konfigurierten 
Audioausgang oder internen Bus routen. Die in 
diesem Popup-Menü verfügbaren Optionen 
werden durch die Ausgangsbuspfad-
Konfiguration im I/O Setup-Dialogfeld festgelegt. 
Von anderen Spuren verwendete Ausgänge 
erscheinen im Popup-Menü des Output Path-
Selektors in Fettschrift.

So entfernen Sie eine Ausgangszuweisung:

 Wählen Sie im Output Path-Selektor No Output. 
Playlists für Spuren, denen kein Ausgang 
zugewiesen ist, werden abgeblendet.

 

Input Path-Selektor

Output Path-Selektor

Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) bzw. Strg- und Alt-Taste 
(Windows) auf den Output Path-Selektor der 
am weitesten links gelegenen Spur und 
wählen Sie den ersten Ausgangspfad (Mono 
oder Stereo). Alle sichtbaren Spuren werden 
automatisch eindeutigen Ausgangspfad-
Zuweisungen in aufsteigender Reihenfolge 
zugewiesen. Beispiel: Spur 1 wird A1–2 
zugewiesen, Spur 2 A3–4, Spur 3 A5–6 und so 
weiter.
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Erstellen und Zuweisen neuer Spuren 
über einen Spurausgang

In Pro Tools können Sie eine neue Auxiliary-
Eingangs-, Audio- oder Instrumentenspur über den 
Output-Selektor erstellen und unter Verwendung 
eines Mix-Busses den Ausgang der ursprünglichen 
Spur dem Eingang der neuen Spur zuweisen.

So erstellen Sie eine neue Spur über den Ausgang 
einer vorhandenen Spur:

1 Klicken Sie auf einer vorhandenen Spur auf den 
Output-Selektor für die Spur und wählen Sie New 

Track.

2 Wählen Sie im New Track-Dialogfeld die 
Optionen Width, Type und Time Base für die neue 
Spur.

3 Geben Sie einen Namen für die neue Spur ein.

4 Aktivieren (oder deaktivieren) Sie das 
Kontrollkästchen „Create next to current track“.

5 Klicken Sie auf OK.

Pro Tools erstellt eine neue Spur, wobei der 
Ausgang der ursprünglichen Spur automatisch 
über einen verfügbaren internen Mix-Bus auf den 
Eingang der neuen Spur geroutet wird. 

Der neue interne Mix-Bus wird bei der Erstellung dem 
Namen der neuen Spur entsprechend benannt. Wenn 
Sie etwa als Namen „Drum Sub“ gewählt haben, heißt 
die in Pro Tools angelegte neue Auxiliary-Eingangs-
Spur ebenfalls „Drum Sub“ und erstellt den internen 
Mix-Bus „Drum Sub“.

Zuweisen einer vorhandenen Spur über 
einen Spurausgang

In Pro Tools können Sie über einen verfügbaren Mix-
Bus einen Spurausgang direkt dem Eingang einer 
vorhandenen Spur zuweisen. Hinweis: Damit die 
Zuweisung für die Zielspur zur Verfügung steht, 
muss sie entweder auf einen internen Mix-Bus oder 
auf No Input festgelegt werden.

Wenn eine Audiospur, ein Auxiliary-Eingang, 
ein Master-Fader oder eine Instrumentenspur 
dem Eintrag „No Output“ zugewiesen wird, 
gehen die Automationsdaten der Spur für 
Panorama- und Plug-In-Parameter verloren. 

New Track-Dialogfeld

Neue Auxiliary-Eingangs-Spur mit Audiospurausgang, 
der automatisch Bus 1–2 zugewiesen ist.
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So weisen Sie den Ausgang einer Spur dem 
Eingang einer vorhandenen Spur zu:

1 Klicken Sie auf einer vorhandenen Spur auf den 
Output-Selektor für die Spur und wählen Sie 
Track.

2 Wählen Sie im Track-Untermenü die 
gewünschte Zielspur.

Pro Tools routet die Spur automatisch auf den 
Eingang der ausgewählten Spur unter Verwendung 
eines verfügbaren internen Mix-Busses.

Umbenennen von Spurenein-
und-ausgängen im Edit-oder 
Mix-Fenster
I/O-Pfadnamen können im Edit-oder Mix-Fenster 
oder im I/O Setup-Dialogfeld umbenannt werden.

So benennen Sie einen I/O-Pfad im Edit- oder Mix-
Fenster um:

1 Klicken Sie im Edit-oder Mix-Fenster mit der 
rechten Maustaste auf den Input-oder Output-
Selektor für eine Spur und wählen Sie im 
Popup-Menü die Rename-Option.

2 Geben Sie im Rename I/O-Dialogfeld einen Namen 
für den I/O-Pfad ein und klicken Sie auf OK.

Deaktivieren von Spureingängen 
und -ausgängen im Edit-oder 
Mix-Fenster
Die Zuweisung von Spureingängen, Spurausgängen 
und Buspfaden kann mithilfe des entsprechenden 
Selektors auf der jeweiligen Spur deaktiviert werden. 
Wenn Sie einen Ein- oder Ausgang einer Spur 
deaktivieren, wird dieser „stumm“, alle Daten der 
Automation und Playlist bleiben aber erhalten. 
Auf Avid HDX-Systemen verbrauchen deaktivierte 
Ein- und Ausgänge keine Ressourcen für DSP-
Mischpult-Verbindungen, aber alle aktiven 
zugewiesenen Plug-Ins auf der Spur nutzen weiterhin 
die von ihnen benötigten DSP-Ressourcen. Auf 
Pro Tools-Systemen verbrauchen deaktivierte Ein- 
und Ausgänge keine Host-Processing-Ressourcen. 
Hostbasierte oder Native-Plug-Ins benötigen CPU-
Ressourcen und DSP-basierte Plug-Ins verwenden die 
auf Avid HDX-Karten verfügbaren DSP-Ressourcen. 

Zuweisen eines Spurausgangs zu einer vorhandenen 
Auxiliary-Eingangs-Spur

 

Rename I/O-Dialogfeld
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Sie können Spureneingänge und -ausgänge direkt 
im Edit- oder Mix-Fenster deaktivieren (oder 
aktivieren). Deaktivierte I/O-Pfade werden 
abgeblendet dargestellt.

Um einen Eingangs- oder Ausgangspfad einer 
Spur zu deaktivieren (oder zu aktivieren), wählen 
Sie eine der folgenden Methoden:

 Klicken Sie im Edit- oder Mix-Fenster mit der 
rechten Maustaste auf den Input- oder Output-
Selektor für eine Spur und wählen Sie im 
Popup-Menü Make Inactive (oder Make Active).

 Halten Sie die Befehls- und Ctrl-Taste (Mac) 
bzw. Windows- und Strg-Taste (Windows) 
gedrückt und klicken Sie im Mix-Fenster oder 
Edit-Fenster auf den Input- oder Output-
Selektor.

Um alle demselben Pfad zugewiesenen 
Spureingänge oder -ausgänge zu deaktivieren 
(oder zu aktivieren), wählen Sie eine der folgenden 
Methoden:

 Klicken Sie im Edit- oder Mix-Fenster bei 
gedrückter Wahl- (Mac) bzw. Alt-Taste 
(Windows) mit der rechten Maustaste auf den 
Input- oder Output-Selektor für eine Spur und 
wählen Sie im Popup-Menü Make Inactive 
(oder Make Active).

 Halten Sie die Befehls-, Wahl- und Ctrl-Taste 
(Mac) bzw. die Strg-, Alt- und Windows-Taste 
(Windows) gedrückt und klicken Sie im Mix-
Fenster oder Edit-Fenster auf den Input- oder 
Output-Selektor.

Um alle demselben Pfad zugewiesenen Eingänge 
oder Ausgänge der ausgewählten Spuren 
zu deaktivieren (oder zu aktivieren), wählen Sie 
eine der folgenden Methoden:

 Klicken Sie im Edit- oder Mix-Fenster bei 
gedrückter Wahl- (Mac) bzw. Alt- (Windows) 
und Umschalttaste mit der rechten Maustaste 
auf den Input- oder Output-Selektor für eine 
Spur und wählen Sie im Popup-Menü die 
Option Make Inactive (oder Make Active).

 Halten Sie Befehl + Wahl + Ctrl + Umschalt 
(Mac) bzw. Strg + Alt + Windows + Umschalt 
(Windows) gedrückt und klicken Sie im Mix-
Fenster oder Edit-Fenster auf den Input- oder 
Output-Selektor.

Aktivieren und Deaktivieren mehrerer Pfade

Wenn einer Spur nur ein Hauptausgang 
zugewiesen ist, können Sie diesen Hauptausgang 
deaktivieren, indem Sie bei gedrückter Befehls-
und Ctrl-Taste (Mac) bzw. Strg- und Windows-
Taste (Windows) auf den Output Path-Selektor der 
Spur klicken. Gibt es mehrere Zuweisungen, wird 
der Track-Selektor angezeigt, über den Sie den 
gewünschten Eingangs-, Ausgangs-, Insert- oder 
Buspfad angeben können. 

Sie können im I/O Setup-Dialogfenster auch 
einen Pfad global deaktivieren (oder 
aktivieren). Siehe „Aktivieren bzw. 
Deaktivieren von Pfaden“ auf Seite 93.

Wenn einem Send (A–J) mehrere 
Ausgangspfade zugewiesen sind und einer 
davon aktiviert oder deaktiviert wird, werden 
alle Ausgangspfadzuweisungen für diesen Send 
(A–J) ebenfalls entsprechend umgeschaltet.
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Priorität von Spuren und 
Voice-Zuweisung
Die Priorität von Spuren und die Voice-Zuweisung 
ist abhängig von Ihrer Pro Tools-Hardware- und 
Softwarekonfiguration.

Avid-HDX-Systeme stellen je nach Anzahl der Karten 
im System eine bestimmte Anzahl von Voices 
(gleichzeitig verfügbare Kanäle für Aufnahme und 
Wiedergabe) zur Verfügung. Einzelheiten zum 
Funktionsumfang eines Pro Tools-Systems finden Sie 
unter „Wiedergabe-, Aufnahme- und Voice-Limits bei 
Pro Tools HD“ auf Seite 45.

Pro Tools-Systeme ermöglichen die Wiedergabe oder 
Aufnahme von bis zu 96 simultanen Stereo- oder 
Monospuren. Einzelheiten zum Funktionsumfang der 
Systeme finden Sie unter „Pro Tools-
Systemfunktionen mit unterschiedlichen Hardware-
Konfigurationen“ auf Seite 41.

Priorität von Spuren
Die Pro Tools-Hardware lässt nur eine bestimmte 
Anzahl von Voices zu, mit der Pro Tools-Software 
sind jedoch zusätzliche Spuren über diese feste 
Anzahl hinaus möglich. Obwohl Sie auf alle diese 
Spuren aufnehmen und diese importieren, 
anordnen und für die Wiedergabe vorsehen 
können, ist es nicht möglich, alle Spuren 
gleichzeitig wiederzugeben. 

Wenn die Anzahl der Spuren die Anzahl der 
verfügbaren Voices übersteigt, sind Spuren mit einer 
niedrigeren Wiedergabepriorität unter Umständen 
nicht mehr zu hören. Aus diesem Grund weist 
Pro Tools den Spuren Prioritäten zu, die um 
vorhandene Voices konkurrieren. Da die Anzahl der 
Spuren höher sein kann als die Anzahl der 
verfügbaren Voices, bietet Pro Tools mehrere 
Möglichkeiten, die Wiedergabepriorität von 
Audiospuren festzulegen. Siehe „Ändern der 
Wiedergabepriorität einer Spur“ auf Seite 241 und 
„Freigeben von Voices auf einer Spur“ auf Seite 241.

Ändern der Wiedergabepriorität 
einer Spur

Die Spuren in den höheren Positionen einer Session 
(ganz links im Mix-Fenster oder ganz oben im Edit-
Fenster) haben Priorität gegenüber den Spuren in den 
unteren Positionen. 

Sie haben folgende Möglichkeiten, einer Spur eine 
höhere Priorität zuzuweisen:

 Ziehen Sie im Mix-Fenster die Schaltfläche mit 
dem Namen der Spur an eine Position links von 
anderen Spuren in der Session. Spuren im Mix-
Fenster ganz links haben eine höhere Priorität als 
die rechts davon liegenden.

 Ziehen Sie im Edit-Fenster die Schaltfläche mit 
dem Namen der Spur an eine Position oberhalb 
anderer Spuren in der Session. Spuren, die im 
Edit-Fenster zuoberst aufgelistet sind, haben eine 
höhere Priorität als die darunter.

 Ziehen Sie den Namen der Spur in der Tracks-
Liste an eine höhere Position. Spuren, die in dieser 
Liste zuoberst aufgelistet sind, haben eine höhere 
Priorität als die darunter liegenden.

Freigeben von Voices auf einer Spur

Die Priorität der Spuren ändert sich auch, wenn Sie 
die Voices bestimmter Spuren freigeben und sie so 
für andere Spuren verfügbar machen. 

Führen Sie zum Freigeben der Voice einer Spur 
einen der folgenden Schritte aus:

 Klicken Sie auf den Voice-Selektor der Spur 
und setzen Sie ihn auf Off. Siehe „Einstellen der 
Voice-Zuweisung“ auf Seite 242.

 Deaktivieren Sie die Spur, indem Sie Strg + 
Windows (Windows) bzw. Befehl + Ctrl (Mac) 
gedrückt halten und im Mix-Fenster auf das 
Symbol für die Spurart klicken.

 Stellen Sie sicher, dass der Spur keine 
Ausgangspfade oder Sends zugewiesen sind. 
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Einstellen der Voice-Zuweisung
Die Voice-Zuweisung einer Spur kann ausgeschaltet 
oder auf dynamische Zuweisung gesetzt werden. 
Mithilfe von „Dynamically Allocated Voicing“ ist die 
automatische Verwaltung der Voices im Hintergrund 
möglich, wobei nicht von anderen Spuren verwendete 
Voices automatisch zugewiesen werden.

So legen Sie die Voice-Zuweisung für eine Spur fest:

 Klicken Sie auf den Voice-Selektor und stellen 
Sie Dyn bzw. Off für die Spur ein.

Priorität von Spuren und Dynamic Voicing
Die Audiospuren mit den niedrigsten Nummern 
(höchste Priorität), die aktiviert sind und für die als 
Voice-Zuweisung DYN (Dynamically Allocated 
Voicing) eingestellt ist, sind die Spuren, die 
wiedergegeben werden. (Die Gesamtanzahl der 
wiedergegebenen Spuren hängt von der auf Ihrem 
System zulässigen Höchstanzahl der Spuren mit 
Voice-Zuweisung ab.)

Spuren mit höheren Nummern (niedrigere 
Priorität) als diese Spuren werden nicht 
wiedergegeben und Sie können auf ihnen nicht 
aufzeichnen. Die ihnen entsprechenden 
Dynamically Allocated Voicing-Schaltflächen sind 
blau, um anzuzeigen, dass sie für Wiedergabe oder 
Aufnahme nicht verfügbar sind.

Wenn Sie mit mehr als der maximal durch Ihr System 
erlaubten Zahl von Spuren mit Voice-Zuweisung 
arbeiten, können Sie die Audiosignale von Spuren mit 
höherer Nummer (niedrigerer Priorität) nur 
wiedergeben, indem Sie die Spurenpriorität auf eine 
der folgenden Weisen ändern:

• Deaktivieren Sie eine Spur mit einer niedrigeren 
Nummer (klicken Sie dazu auf den Spurnamen 
und wählen Sie Track > Make Inactive).

• Stellen Sie für die Voice-Zuweisung in einer Spur 
mit einer niedrigeren Nummer Off ein (klicken Sie 
auf den Voice-Selektor und wählen Sie Off).

• Ziehen Sie die Spurnamen-Schaltfläche der Spur 
mit der höheren Nummer nach links (Mix-Fenster) 
bzw. nach oben (im Edit-Fenster oder der Tracks-
Liste), bis sie im Bereich der maximal durch Ihr 
System erlaubten Zahl von Spuren mit Voice-
Zuweisung liegt. Die zuvor zuletzt mit einer Voice-
Zuweisung belegte Spur wird aus dem Bereich 
bewegt und ihre Voice-Zuweisung wird in Off 
geändert.

In Pro Tools HD sind für QuickPunch, 
TrackPunch und DestructivePunch 
zusätzliche Voices erforderlich. Weitere 
Informationen finden Sie unter Kapitel 23: 
„Punch-Aufnahmemodi“.

In Pro Tools|HDX-Systemen werden in 
bestimmten Fällen beim ersten Einschleifen 
eines (hostbasierten) Native-Plug-Ins 
zusätzliche Voices benötigt. Siehe „Voice-
Auslastung und Gesamtlatenz für native 
(hostbasierte) Plug-Ins“ auf Seite 1039.

Voice-Selektor einer Stereo-Audiospur

Spuren werden nicht wiedergegeben, wenn 
sie deaktiviert sind oder ihre Voice-
Zuweisung auf „Off“ eingestellt ist.
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Sobald die Priorität der Spur mit der höheren Nummer 
geändert wird, wird die Voice-Zuweisung für diese 
Spur automatisch von Off in DYN geändert.

Zuweisen von MIDI-Ein- und 
Ausgängen an Spuren
Die MIDI-Aufnahme und -Wiedergabe wird für 
MIDI- und Instrumentenspuren unterstützt.

Die MIDI-Anschlüsse Ihres Systems können in 
Pro Tools benannt und für die Verwendung in 
Pro Tools konfiguriert werden (für Windows siehe 
„Konfigurieren von MIDI Studio“ und für Mac 
siehe „Konfigurieren von AMS“). 

Zuweisen von MIDI-
Spureingängen
Pro Tools ermöglicht die Zuweisung bestimmter 
MIDI-Anschlüsse und -Kanäle zu MIDI-
Spureingängen. Die Standardauswahl ist „All“. 
Dabei werden alle eingehenden MIDI-Daten von 
allen Anschlüssen auf allen Kanälen empfangen. 
Um einen bestimmten MIDI-Anschluss und -
Kanal für den Eingang festzulegen, verwenden Sie 
den MIDI Input-Selektor.

So weisen Sie einer MIDI-Spur einen Eingang zu:

 Klicken Sie auf den MIDI Input-Selektor der 
Spur und weisen Sie einen Anschluss und einen 
Kanal für den MIDI-Eingang zu. Kanäle, die 
bereits einer anderen Spur zugewiesen sind, 
erscheinen hier fett.

Informationen zum Zuweisen von MIDI-
Eingängen zu Instrumentenspuren finden Sie 
unter „Zuweisen von MIDI-Eingängen und -
Ausgängen für Instrumentenspuren“ auf 
Seite 245.

Wählen Sie im Edit-Fenster „View > Edit 
Window > I/O“, um auf den Input-Selektor 
einer beliebigen Spur zuzugreifen.

MIDI Input-Selektor (hier: MIDI-Spur)



Pro Tools-Referenzhandbuch244

Zuweisen von MIDI-
Spurausgängen
Pro Tools ermöglicht die Zuweisung bestimmter 
MIDI-Anschlüsse und -Kanäle zu MIDI-
Spurausgängen. Die Standardeinstellung ist „None“. 
Dabei werden MIDI-Daten an keinen Anschluss oder 
Kanal gesendet. Um einen bestimmten MIDI-
Anschluss und -Kanal für den Ausgang festzulegen, 
verwenden Sie den MIDI Output-Selektor.

So weisen Sie einer MIDI-Spur (und ihren Clips) 
einen bestimmten Kanal eines MIDI-Geräts zu:

 Klicken Sie auf den MIDI Output-Selektor der 
Spur und weisen Sie einen Anschluss und einen 
Kanal für den MIDI-Eingang zu. Kanäle, die 
bereits einer anderen Spur zugewiesen sind, 
erscheinen hier fett.

So weisen Sie einer einzelnen MIDI-Spur mehrere 
verschiedene Ausgangskanäle zu:

 Klicken Sie bei gedrückter Ctrl-Taste (Mac) bzw. 
mit der rechten Maustaste (Mac oder Windows) 
auf den MIDI Output-Selektor und wählen Sie 
zusätzliche Kanäle beliebiger Geräte aus.

In Pro Tools kann eine MIDI-Spur nicht 
mehrere Kanäle mit MIDI-Daten enthalten.

Informationen zum Zuweisen von MIDI-
Ausgängen zu Instrumentenspuren finden Sie 
unter „Zuweisen von MIDI-Eingängen und -
Ausgängen für Instrumentenspuren“ auf 
Seite 245.

Wählen Sie im Edit-Fenster „View > Edit 
Window > I/O“, um auf den Output-Selektor 
einer beliebigen Spur zuzugreifen.

MIDI Output-Selektor (hier: MIDI-Spur)

Informationen zum Aufnehmen und 
Importieren von MIDI-Daten finden Sie 
unter Kapitel 22: „MIDI-Aufnahme“.
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Zuweisen von MIDI-Eingängen 
und -Ausgängen für 
Instrumentenspuren
Bei Instrumentenspuren steht eine spezielle 
Darstellung für MIDI-Steuerelemente zur Verfügung, 
einschließlich MIDI Input- und Output-Selektoren.

Um die MIDI-Steuerelemente von 
Instrumentenspuren anzuzeigen, haben Sie 
folgende Möglichkeiten:

 Wählen Sie View > Mix Window > Instruments.

 Wählen Sie View > Edit Window > Instruments.

MIDI-Eingang für Instrumentenspur

Pro Tools ermöglicht die Zuweisung bestimmter 
MIDI-Anschlüsse und -Kanäle zu MIDI-Eingängen 
von Instrumentenspuren. Die Standardauswahl ist 
„All“. Dabei werden alle eingehenden MIDI-Daten 
von allen Anschlüssen auf allen Kanälen empfangen. 
Um einen bestimmten MIDI-Anschluss und -Kanal 
für den Eingang festzulegen, verwenden Sie den 
MIDI Input-Selektor.

Von anderen Spureingängen verwendete Kanäle 
erscheinen im MIDI Input-Popup-Menü 
in Fettschrift.

So weisen Sie einer Instrumentenspur einen MIDI-
Eingang zu:

 Klicken Sie auf den MIDI Input-Selektor der 
Spur und weisen Sie einen Anschluss und einen 
Kanal für den MIDI-Eingang zu. Kanäle, die 
bereits einer anderen Spur zugewiesen sind, 
erscheinen hier fett.

MIDI-Ausgang für Instrumentenspur

Pro Tools ermöglicht die Zuweisung bestimmter 
MIDI-Anschlüsse und -Kanäle zu MIDI-
Ausgängen von Instrumentenspuren. Die 
Standardeinstellung ist „None“. Dabei werden 
MIDI-Daten an kein Gerät, keinen Anschluss und 
keinen Verbindungspunkt auf beliebigen Kanälen 
gesendet. Um einen bestimmten MIDI-Anschluss 
und -Kanal für den Ausgang festzulegen, 
verwenden Sie den MIDI Output-Selektor.

Von anderen Spureneingängen verwendete Kanäle 
erscheinen im MIDI Input-Popup-Menü in Fettschrift.

So weisen Sie einer Instrumentenspur einen MIDI-
Ausgang zu:

 Klicken Sie auf den MIDI Output-Selektor der 
Spur und weisen Sie einen Anschluss und einen 
Kanal für den MIDI-Eingang zu. Kanäle, die 
bereits einer anderen Spur zugewiesen sind, 
erscheinen hier fett.

Instrumentenspuren können nicht nur zum 
Zuweisen von MIDI-Eingängen und -
Ausgängen für die Aufnahme und 
Wiedergabe von MIDI-Daten verwendet 
werden, sondern auch, um Audiosignale von 
Ihren Hardware-MIDI-Instrumenten und 
Instrumenten-Plug-Ins abzuhören. Siehe 
„Signal-Routing zum Abhören und Erstellen 
von Submixes“ auf Seite 1014.

Instruments-Bedienfeld (Mix-Fenster)

MIDI Input-Selektor

MIDI Output-Selektor
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Solo- und Stummschalten 
von Spuren
Sie können die Solo- und die Mute-Schaltfläche 
während der Wiedergabe jederzeit aktivieren. Sie 
können sowohl MIDI- als auch Audiospuren solo- 
oder stummschalten. Außerdem können Sie in 
einer Session auch mehr als eine Spur gleichzeitig 
solo- oder stummschalten.

Die Gruppierung von Spuren hat ebenfalls Einfluss 
auf die Funktionsweise der Solo- und 
Stummschaltung. Das Stumm- oder Soloschalten 
einer Spur aus einer aktiven Mix-Gruppe bewirkt, 
dass auch alle anderen Spuren dieser Gruppe stumm- 
bzw. sologeschaltet werden.

Soloschalten von Spuren

So schalten Sie Spuren solo:

1 Klicken Sie auf die Solo-Schaltfläche einer 
Spur. Die Schaltfläche wird markiert und alle 
anderen Spuren werden stummgeschaltet.

2 Klicken Sie auf die Solo-Schaltfläche einer 
weiteren Spur. Die Solo-Schaltflächen auf 
beiden Spuren werden nun markiert und alle 
anderen Spuren sind stummgeschaltet.

So haben Sie die Soloschaltung wieder auf:

 Klicken Sie auf die Solo-Schaltfläche der 
sologeschalteten Spuren.

Solo-Schaltfläche
Mit der Solo-Schaltfläche schalten Sie 
normalerweise andere Spuren stumm, damit die 
ausgewählte Spur unabhängig von den anderen 
abgehört werden kann.

In Pro Tools HD wird dieses Verhalten als Solo-
Modus ausgewählt und als „Solo In Place“ 
bezeichnet. Es stehen darüber hinaus weitere Solo-
Modi zur Verfügung, die die Funktionsweise der 
Solo-Schaltfläche beeinflussen. Siehe „Solo-Modi“ 
auf Seite 246.

Solo-Modi
(Nur Pro Tools HD)

In Pro Tools HD kann die Solo-Schaltfläche wie 
folgt verwendet werden:

• Stummschalten anderer Spuren, damit die 
ausgewählte Spur einzeln abgehört werden kann

• Routen der ausgewählten Spur auf einen 
gesonderten Ausgang

Die Funktionsweise der Solo-Schaltfläche wird 
durch den Solo-Modus bestimmt. Dabei gilt:

SIP (Solo In Place). – die Solo-Schaltfläche schaltet 
die übrigen Spuren stumm. In diesem Modus können 
Spuren in den Solo Safe-Zustand geschaltet werden 
(siehe „Solo Safe-Modus“ auf Seite 248).

AFL (After Fader Listen, nur Pro Tools HD mit 
Avid HDX oder HD Native-Hardware). – mithilfe 
der Solo-Schaltfläche wird das Post-Fader-/Post-Pan-
Signal an den Ausgang für den AFL-/PFL-Pfad 
geleitet. Der AFL-/PFL-Pfad wird auf der Output-
Registerkarte des I/O Setup-Dialogfelds konfiguriert 
(siehe „AFL-/PFL-Pfad“ auf Seite 79). 

Mit AFL ist der hörbare Pegel vom Fader-Pegel 
der betreffenden Spur abhängig. Darüber hinaus ist 
eine gesonderte Master-Pegeleinstellung für AFL 
verfügbar, die sich auf den Ausgang beliebiger 
oder aller Spuren auswirkt, die Sie im AFL-Modus 
auf Solo schalten (siehe „AFL-/PFL-Pfad“ auf 
Seite 79). Diese Pegeleinstellung ist unabhängig 
von der PFL-Pegeleinstellung.

Bei Instrumentenspuren stehen eigene 
Gruppen von Solo- und 
Stummschaltungsschaltflächen zum Abhören 
von MIDI- und Audiodaten zur Verfügung.

Informationen zum Erstellen und Ändern von 
Gruppen für die Solo- und Stummschaltung von 
Spuren erhalten Sie unter „Gruppieren von 
Spuren“ auf Seite 255.
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PFL (Pre Fader Listen, nur Pro Tools HD mit 
Avid HDX oder HD Native-Hardware). – mithilfe 
der Solo-Schaltfläche wird das Pre-Fader-/Pre-Pan-
Signal an den Ausgang des AFL-/PFL-Pfads geleitet. 
Der AFL-/PFL-Pfad wird auf der Output-
Registerkarte des I/O Setup-Dialogfelds konfiguriert 
(siehe „AFL-/PFL-Pfad“ auf Seite 79). 

Bei PFL werden der Fader-Pegel und das Fader-
Panorama ignoriert und der hörbare Pegel ist vom 
aufgezeichneten Pegel des Signals abhängig. Darüber 
hinaus ist eine gesonderte Master-Pegeleinstellung für 
PFL verfügbar, die sich auf den Ausgang beliebiger 
oder aller Spuren auswirkt, die Sie im PFL-Modus auf 
Solo schalten (siehe „AFL-/PFL-Pfad“ auf Seite 79). 
Diese Pegeleinstellung ist unabhängig von der AFL-
Pegeleinstellung.

So wählen Sie einen Solo-Modus:

1 Wählen Sie Options > Solo Mode.

2 Wählen Sie SIP, AFL oder PFL.

DSP-Auslastung im AFL- oder PFL-Modus

Pro Tools erstellt für AFL und PFL eine Art 
„Hintergrund-Mischer“, um das Signal an den 
gewählten AFL/PFL-Pfad zu leiten. Je nach Größe 
des Hauptmischers nutzt Pro Tools im AFL- oder 
PFL-Modus u. U. einen großen Teil der 
verfügbaren DSP-Ressourcen.

Wird die Zuweisung des AFL-/PFL-Pfads 
aufgehoben, werden die für den AFL/PFL-Modus 
verwendeten DSP-Ressourcen wieder freigegeben.

Verwenden von AFL/PFL in Pro Tools-
Systemen mit einer D-Control- oder 
D-Command-Konsole

AFL/PFL ist für Pro Tools-Systeme mit einer 
D-Control- oder D-Command-Bedienoberfläche 
optimiert, wobei das XMON seine Abhörquelle 
automatisch zwischen dem Hauptausgang und dem 
AFL-/PFL-Ausgang von Pro Tools umschaltet.

Verwenden von AFL/PFL in Pro Tools-
Systemen ohne D-Control oder D-Command

Wenn Sie keine D-Control- oder D-Command-
Bedienoberfläche verwenden, wird der normale 
Pro Tools-Ausgangspfad beim Senden von 
Signalen an den AFL-/PFL-Pfad nicht unbedingt 
stummgeschaltet. Wenn das Hauptsignal beim 
Aufrufen eines AFL-/PFL-Signals unbedingt 
automatisch stummgeschaltet werden soll, müssen 
Sie wie folgt vorgehen: 

1 Konfigurieren Sie den Ausgangspfad für Spuren, 
die mit AFL bzw. PFL sologeschaltet werden.

2 Wählen Sie den Hauptausgangspfad, der 
stummgeschaltet werden soll, wenn Sie eine 
Spur im AFL- oder PFL-Modus soloschalten 
(siehe „AFL-/PFL-Stummschaltung 
(Ausgangspfad)“ auf Seite 79).

Für die Solo-Modi AFL und PFL ist das 
Surround Mixer-Plug-In erforderlich. 

Benutzerdefinierte Einstellungen für Pan-
Tiefen sind nicht verfügbar, wenn der AFL- 
oder PFL-Solo-Modus aktiviert ist.

Ist die Option „Mute Frees Assigned Voice“ 
aktiviert, sind stummgeschaltete Spuren im 
PFL-Modus nicht hörbar.

Der Solo-Modus kann für alle sologeschalteten 
Spuren von jedem beliebigen Modus aus in SIP 
oder AFL umgestellt werden. Die zuvor 
sologeschalteten Spuren werden in den neuen 
Modus umgeschaltet.

Wenn Sie den Modus aller sologeschalteten 
Spuren auf PFL umstellen, wird die 
Soloschaltung der Spuren vor dem Umschalten 
in PFL aufgehoben. Dadurch wird ein 
übermäßiges Ansteigen des Pegels vermieden.

Weitere Informationen zur Verwendung von 
XMON und AFL/PFL finden Sie im 
Benutzerhandbuch zur Bedienoberfläche.
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3 Richten Sie die Hardware so ein, dass sowohl 
der Hauptausgangspfad als auch der AFL-/PFL-
Pfad gleichzeitig abgehört werden.

Wenn Sie AFL oder PFL als Solo-Modus wählen und 
eine Spur soloschalten, wird der Hauptausgangspfad 
stummgeschaltet und das AFL-/PFL-Signal kann am 
AFL-/PFL-Pfad abgehört werden.

Solo Latch-Optionen
Sie können Solos koppeln (wobei weitere Spuren 
durch das Klicken auf ihre Schaltflächen dem Solo-
Mix hinzugefügt werden), ihre Kopplung aufheben 
oder sie vorübergehend koppeln (nur Pro Tools HD).

So wählen Sie einen Solo-Latch-Modus:

 Wählen Sie Options > Solo Mode und wählen 
Sie aus folgenden Optionen:

Latch. – diese Option bewirkt, dass dem Solo-Mix 
bei der Auswahl weiterer Soloschaltungen die 
entsprechenden Spuren hinzugefügt werden.

X–OR (Cancels Previous Solos). – bei dieser 
Option werden bei der Auswahl neuer 
Soloschaltungen die bestehenden aufgehoben.

Momentary (nur Pro Tools HD). – ist diese Option 
aktiviert, bleibt die Einstellung der Solotasten 
nicht erhalten. Eine Spur wird nur dann 
sologeschaltet, wenn der entsprechende Solo-
Schalter gedrückt gehalten wird.

Mit einer geeigneten Bedienoberfläche können 
durch Drücken der entsprechenden SOLO-
Schalter weitere Spuren sologeschaltet werden, 
solange mindestens eine Solotaste gedrückt 
gehalten wird. Ist kein SOLO-Schalter gedrückt, 
wird die Soloschaltung aller Spuren aufgehoben.

Zeitweiliges Koppeln von Solos im Momentary-
Solo-Modus

(Nur Pro Tools HD)

So koppeln Sie Solos zeitweilig:

1 Wählen Sie Options > Solo Mode > Momentary.

2 Halten Sie die Solo-Schaltfläche für die erste 
Spur gedrückt, die Sie auf Solo 
schalten möchten.

3 Halten Sie diese Schaltfläche gedrückt und drücken 
Sie weitere Solo-Schaltfläche. Die betreffenden 
Spuren bleiben sologeschaltet, solange eine Solo-
Schaltfläche festgehalten wird.

Solo Safe-Modus
In Pro Tools können Sie eine Spur auf Solo Safe 
schalten. Damit wird verhindert, dass die Spur 
stummgeschaltet wird, auch wenn Sie andere 
Spuren soloschalten. Diese Funktion ist sinnvoll, 
wenn Spuren wie etwa Auxiliary-Eingänge als 
Submix von Audiospuren oder zur Rückführung 
von Effektsignalen genutzt werden. Die 
Audiosignale bzw. die Spur mit dem Effekt bleibt 
so in der Mischung, auch wenn andere Spuren 
sologeschaltet worden sind. Auch für MIDI-
Spuren kann der Solo Safe-Modus sinnvoll sein, 
damit deren Wiedergabe nicht beeinträchtigt wird, 
wenn Sie Audiospuren soloschalten.

So aktivieren Sie den Solo Safe-Modus für eine Spur:

 Halten Sie die Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) gedrückt und klicken Sie auf 
die Solo-Schaltfläche der betreffenden Spur. 
Damit wird verhindert, dass die Spur 
stummgeschaltet wird, auch wenn Sie andere 
Spuren soloschalten. Im Solo Safe-Modus ist die 
Solo-Schaltfläche transparent.

Um den X–OR-Modus außer Kraft zu setzen 
und mehrere Spuren gleichzeitig 
solozuschalten, halten Sie die Solo-
Schaltfläche für die erste Spur gedrückt. Die 
Spuren der später gedrückten Solotasten 
werden dann gekoppelt.

Solange mindestens eine Solo-Schaltfläche 
gedrückt gehalten wird, bleiben alle 
Soloschaltungen bestehen.

Für mit AFL oder PFL sologeschaltete 
Spuren (nur Pro Tools HD) steht „Solo 
Safe“ nicht zur Verfügung.
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So deaktivieren Sie den Solo Safe-Modus für 
eine Spur:

 Halten Sie die Strg- (Windows) bzw. Befehlstaste 
(Mac) gedrückt und klicken Sie erneut auf die 
Solo-Schaltfläche der betreffenden Spur.

Mute-Schaltfläche
Mit der Mute-Schaltfläche wird eine Spur 
stummgeschaltet. Es können auch mehrere Spuren 
gleichzeitig stummgeschaltet werden.

So schalten Sie eine Spur stumm:

 Klicken Sie in der Spur auf die Mute-Schaltfläche.

So deaktivieren Sie die Stummschaltung für 
eine Spur:

 Klicken Sie erneut auf die Mute-Schaltfläche.

MIDI Mute

Über die Mute-Taste auf einer MIDI-Spur werden 
MIDI-Daten und nicht Audiodaten stummgeschaltet. 
Das Stummschalten von MIDI führt dazu, dass keine 
MIDI-Daten an den MIDI-Ausgang weitergeleitet 
werden. Auf Instrumentenspuren wird durch die 
Mute-Taste der Spur das Audiosignal 
stummgeschaltet, und die MIDI Mute-Taste ist nur im 
Instruments-Bedienfeld verfügbar.

Deaktivieren von Spuren
Audio-, Auxiliary-Eingangs-, Master-Fader-, 
VCA Master-Spuren (nur Pro Tools HD) und 
Instrumentenspuren können deaktiviert werden. 
Deaktivierte Spuren verbrauchen keine DSP-
Ressourcen und keine Voices. Plug-Ins, Sends, Voices 
und die Automation auf inaktiven Spuren werden 
ebenfalls deaktiviert. Spuren können außerdem 
automatisch deaktiviert werden, wenn eine Session in 
einem System geöffnet wird, in dem weniger DSP-
Leistung zur Verfügung steht als in dem System, in 
dem sie ursprünglich erstellt wurde.

So aktivieren/deaktivieren Sie eine Spur:

 Halten Sie Befehl + Ctrl (Mac) bzw. Strg + 
Windows (Windows) gedrückt und klicken Sie 
im Mix-Fenster auf die Anzeige der Spurart.

Die Playlists und Steuerelemente für inaktive 
Spuren werden abgeblendet.

Führen Sie einen der folgenden Schritte aus, um 
eine oder mehrere Spuren zu deaktivieren oder zu 
aktivieren:

 Wählen Sie die Spur und dann Track > Make 

Inactive/Active. 

 Klicken Sie mit der rechten Maustaste in der 
Tracks-Liste bzw. im Mix- oder Edit-Fenster 
auf den Namen der Spur und wählen Sie Make 

Inactive/Active.

MIDI Mute-Schaltfläche, Instruments-Bedienfeld, 
Mix Fenster

MIDI-Spuren können nicht deaktiviert werden.

Um mehrere Spuren zu selektieren, klicken 
Sie bei gedrückter Befehls- (Mac) bzw. Strg-
Taste (Windows) auf die entsprechenden 
Spurnamen.

Um mehrere Spuren zu selektieren, klicken 
Sie bei gedrückter Umschalttaste auf die 
gewünschten Spurnamen, die den Bereich 
der Spuren begrenzen, den Sie auswählen 
möchten.
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Farbliche Kennzeichnung 
von Spuren, Clips, Markern 
und Gruppen
Audio- und MIDI-Clips, Spuren, Marker und 
Gruppen können verschiedene Farben zugewiesen 
werden. Die im Edit-Fenster in Waveform- oder 
Blockdarstellung angezeigten Clips werden farbig 
dargestellt. Für die in der Tracks-Liste, der Groups-
Liste, dem Mix- und dem Edit-Fenster angezeigten 
Spuren sind Farbleisten vorhanden.

Farbleisten

Die farbliche Kennzeichnung auf Spuren-Ebene 
erfolgt über Farbleisten. Dabei gilt:

Mix-Fenster. – die Spurfarben werden in horizontalen 
Farbleisten oberhalb der einzelnen Kanalzüge und 
unterhalb des Spurnamens angezeigt. 

Edit-Fenster. – die Spurfarben werden in 
vertikalen Farbleisten links neben den einzelnen 
Spuren angezeigt.

Spurenliste. – die Spurfarben werden in vertikalen 
Farbleisten links neben den einzelnen Spurnamen 
angezeigt.

Gruppenliste. – die Spurfarben werden als 
vertikale Farbleisten links neben den Namen der 
einzelnen Gruppen angezeigt.

Den Spuren werden automatisch Standardfarben 
zugewiesen, die jedoch geändert werden können. 
Dazu können Sie aus einer Farbpalette mit 96 
Farben auswählen. Weitere Informationen finden 
Sie unter „Farbpalette“ auf Seite 251.

Einstellungen für die farbliche 
Kennzeichnung auf der 
Display-Registerkarte
Die Optionen für die farbliche Kennzeichnung 
bestimmen, wie die Farben der Anzeige von 
Spuren und Clips zugewiesen werden.

So ändern Sie die Optionen zur farblichen 
Kennzeichnung:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Display-Registerkarte.

3 Aktivieren Sie die Always Display Marker 

Colors-Option.

4 Wählen Sie die MIDI Note Color Shows 

Velocity-Option.

5 Aktivieren oder deaktivieren Sie die Apply 

Color Coding to Track Channel Strip-Option.

6 Wählen Sie eine Option unter Default Track 

Color Coding.

7 Wählen Sie eine Option unter Default Clip Color 

Coding.

8 Klicken Sie auf OK.

Always Display Marker Colors

Mit dieser Einstellung können Sie Marker-Farben 
in der Markers-Leiste anzeigen, unabhängig 
davon, welche Option Sie für Default Clip Color 

Coding wählen. 

MIDI Note Color Shows Velocity

Ist diese Option aktiviert, werden MIDI-Noten (in 
der MIDI-Notendarstellung) im Edit- und MIDI 
Editor-Fenster in unterschiedlichen 
Schattierungen der zugewiesenen Spurfarbe 
angezeigt. Noten mit hohen Velocity-Werten sind 
dunkler und Noten mit niedrigeren Velocity-
Werten sind heller.
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Default Track Color Coding

Die Default Track Color Coding-Optionen 
bestimmen, wie die Farben der Anzeige von 
Spuren zugewiesen werden. 

None. – deaktiviert die Zuweisung der 
Standardfarbe für Spuren.

Tracks and MIDI Channels. – weist die Spurfarbe 
im Mix- oder Edit-Fenster je nach Voice- und 
MIDI-Kanal-Zuweisung zu.

Tracks and MIDI Devices. – weist die Spurfarbe 
im Mix- oder Edit-Fenster je nach Voice- und 
MIDI-Gerät-Zuweisung zu.

Gruppen. – weist jeder Spur je nach Mix- oder Edit-
Gruppen-ID eine Farbe zu. Wenn Gruppen mithilfe 
des Suspend Groups-Befehls ausgesetzt werden, 
werden die Farbleisten der Spuren nicht angezeigt.

Spurart. – weist jeder Spur je nach Art (Audio, 
Auxiliary-Eingang, Master-Fader, VCA Master, 
MIDI, Instrument oder Video) eine Farbe zu.

Default Clip Color Coding

Die Optionen für Default Clip Color Coding 
bestimmen, wie die Farben der Anzeige von 
Spuren, Clips in der Spur-Playlist und Clipliste 
sowie Markerpositionen zugewiesen werden. 

None. – deaktiviert die Zuweisung der Standardfarbe 
für Clips. Clips werden als schwarze Wellenformen 
oder schwarze MIDI-Noten auf einem hellgrauen 
Hintergrund dargestellt.

Tracks and MIDI Channels. – weist die Clip-Farbe 
im Edit-Fenster je nach Voice- oder MIDI-Kanal-
Zuweisung zu.

Tracks and MIDI Devices. – weist die Clip-Farbe 
im Edit-Fenster je nach Voice- oder MIDI-Gerät-
Zuweisung zu.

Gruppen. – weist die Clip-Farbe je nach Gruppen-
ID der entsprechenden Spur zu. Wenn Gruppen 
(mithilfe des Suspend Groups-Befehls) ausgesetzt 
sind, werden in allen Clips schwarze 
Wellenformen oder schwarze MIDI-Noten auf 
hellgrauen Hintergrund dargestellt.

Track Color. – weist die Clip-Farbe je nach der 
Farbe der entsprechenden Spur zu. (Siehe 
„Farbpalette“ auf Seite 251.)

Marker Locations. – weist jedem Marker-Bereich in 
der Markers-Leiste, einschließlich des Bereichs vor 
dem ersten Marker, eine eindeutige Farbe zu.

Clip List Color. – weist die Clip-Farbe entsprechend 
der jeweiligen Farbe des Clips in der Clipliste zu. Ist 
diese Default Clip Color Coding-Option aktiviert, bleibt 
die zugewiesene Farbe des Clips auch dann erhalten, 
wenn der Clip in eine Spur eingefügt wird, der eine 
andere Farbe zugewiesen wurde. 

Farbpalette
Die Farbpalette ermöglicht die Auswahl von 
Farben für Spuren, Clips, Gruppen und Marker. 

Wenn Sie eine andere Default Clip Color 
Coding-Option wählen als „Clip List Color“, 
wird diese außer Kraft gesetzt. Den Kopien 
der Clips, die in Spuren eingefügt werden, 
wird dann die Farbe der jeweiligen Spur 
zugewiesen. Die Kopien der Clips in der 
Clipliste behalten ihre eindeutige Farbe.

Farbpalette

Auf Ausgewählte anwenden
Auf Kanalzug anwenden

Saturation
Brightness

Default
None

Letzte zugewiesene Farbe Hold
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Die Farbpalette ermöglicht die unabhängige 
Zuweisung von Farben in der Clipliste und in Spuren.

So wenden Sie eine Farbe aus der Farbpalette an:

1 Wählen Sie Windows > Color Palette.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie im Apply to Selected-Popup-Menü 
das Ziel für die Farbcodierung: Tracks, Marker, 

Group, Clips in Tracks oder Clips in Clip List.

• Wählen Sie im betreffenden Pro Tools-Fenster 
eine Spur, einen Marker, eine Gruppe, einen 
Clip in einer Spur oder einen Clip in der 
Clipliste. Im Apply to Selected-Menü wird die 
Art des ausgewählten Elements angezeigt.

3 Wählen Sie eine Farbe aus der Palette oder 
wählen Sie eine der folgenden Optionen:

Default. – hebt alle benutzerdefinierten 
Farbkennzeichnungen auf und stellt die 
Standardeinstellungen für die Farben wieder her. 
Weitere Hinweise finden Sie unter „Einstellungen 
für die farbliche Kennzeichnung auf der 
Display-Registerkarte“ auf Seite 250.

None. – deaktiviert die Zuweisung von Farben. 
Die davon betroffenen Clips werden durch 
schwarze Wellenformen oder MIDI-Noten auf 
hellgrauem Hintergrund dargestellt. Bei Spuren 
und Gruppes werden die Farbleisten nicht mehr 
angezeigt.

Die Hold-Schaltfläche 
Die Hold-Schaltfläche der Farbpalette erleichtert 
das Zuweisen derselben Farbe zu mehreren 
verschiedenen Elementen (etwa Spuren und 
Clips).

Die Hold-Schaltfläche ist standardmäßig 
deaktiviert. In diesem Zustand wird in der 
Farbpalette automatisch die zugewiesene Farbe 
der Elemente hervorgehoben, die Sie auswählen. 

Ist die Hold-Schaltfläche aktiviert, bleibt die in der 
Farbpalette ausgewählte zugewiesene Farbe 
ausgewählt und ändert sich nicht, wenn eine andere 
Spur oder ein anderer Clip ausgewählt wird. 

So weisen Sie mehreren Elementen mithilfe der 
Hold-Schaltfläche dieselbe Farbe zu: 

1 Klicken Sie auf die Hold-Schaltfläche, um sie zu 
aktivieren. Die Hold-Schaltfläche wird weiß und 
die momentan ausgewählte Farbe wird mit einem 
dicken weißen Rand hervorgehoben. 

2 Wählen Sie weitere Spuren oder Clips aus, 
denen Sie dieselbe Farbe zuweisen möchten. Da 
die Hold-Schaltfläche aktiviert ist, folgt die 
Auswahl in der Farbpalette nicht der Auswahl 
der Elemente. Stattdessen bleibt die zuletzt 
zugewiesene Farbe bestehen (sie 
wird „festgehalten“). 

3 Klicken Sie erneut auf die zugewiesene Farbe, um 
sie der neuen Auswahl von Spuren oder Clips 
zuzuweisen. Legen Sie mithilfe des Apply to 
Selected-Popup-Menüs fest, auf welche 
ausgewählten Elemente sich dies auswirken soll. 

4 Um die Hold-Einstellung zu deaktivieren und 
die Farbpalette in den Standardmodus 
zurückzuschalten, klicken Sie so lange auf die 
Hold-Schaltfläche, bis sie deaktiviert wird. 

Wenn Sie einen Marker auswählen, die Marker-
Option jedoch nicht im „Apply to Selected“-
Popup-Menü angezeigt wird, ist auf der 
„Display Preferences“-Registerkarte die 
„Always Display Marker Colors“-Option 
deaktiviert. Weitere Hinweise finden Sie unter 
„Always Display Marker Colors“ auf 
Seite 250.
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Anwenden der farblichen 
Kennzeichnung von Spuren 
auf Kanalzüge
Die Farbpalette ermöglicht es, die farbliche 
Kennzeichnung der Spuren auf Kanalzüge im 
Mix-und Edit-Fenster anzuwenden.

So wenden Sie die farbliche Kennzeichnung von 
Spuren auf Kanalzüge an:

1 Aktivieren Sie die Apply to Channel 
Strip-Schaltfläche.

2 Passen Sie, wenn erforderlich, den Schieberegler 
für die Sättigung an, um die gewünschte 
Farbsättigung zu erreichen. 

3 Passen Sie, wenn erforderlich, den 
Schieberegler für die Helligkeit an. 

Farbliche Kennzeichnung auf Kanalzüge angewendet 
(Mix-Fenster)
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Kapitel 14: Gruppieren von Spuren

Pro Tools bietet eine Gruppierfunktion zum 
Koppeln von Spuren und ihren Steuerelementen. 

Gruppieren von Spuren
Gruppen ermöglichen die gleichzeitige und 
identische Bearbeitung mehrerer Spuren oder das 
Mischen mehrerer Spuren (etwa eines Stereospur-
Paars oder eines Submix) unter Beibehaltung 
desselben relativen Pegels. 

Pro Tools unterstützt die folgenden 
Gruppierfunktionen:

• Bis zu 104 verschiedene Gruppen sind 
verfügbar, die in 4 Bänken zu je 26 Group-IDs 
angeordnet sind.

• Gruppen können verschachtelt werden 
(Untergruppen innerhalb von Gruppen).

• Gruppierte Fader oder Controller behalten ihre 
Pegel relativ zueinander bei.

• Gruppen können einer verfügbaren VCA 
Master-Spur zugewiesen werden 
(nur Pro Tools HD).

Mix-Gruppen, Edit-Gruppen und 
Mix/Edit-Gruppen
Mix-Gruppen wirken sich nur auf Mix-Funktionen 
und Edit-Gruppen wirken sich auf das Editieren 
auf. Mix/Edit-Gruppen verknüpfen die 
Gruppierungsfunktionen der Mix-Gruppe und der 
Edit-Gruppe.

Edit-Gruppen

Edit-Gruppen wirken sich auf die folgenden 
Elemente in den Edit- und MIDI Editor-
Fenstern aus:

• Track View

• Track Height

• Spur-Zeitbasis

• Funktionen zum Editieren von Audio und MIDI

• Funktionen zum Editieren von Automation
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Mix-Gruppen in Pro Tools HD

Mix-Gruppen in Pro Tools HD können so 
eingestellt werden, dass sie sich auf folgende 
Elemente auswirken:

• Main-Stummschaltung

• Solo

• Send Level 

• Send Mute

• Main-Lautstärke

• Main-Panorama

• Main-LFE-Pegel

• Record Enable

• Input Monitoring

• Automationsmodus

• Send Pan

• Send-LFE-Pegel

• Plug-In-Einstellungen

• Plug-In-Bypass

Mix-Gruppen in Pro Tools

Mix-Gruppen in Pro Tools wirken sich immer auf 
Folgendes aus:

• Main-Lautstärke

• Automationsmodus

Mix-Gruppen in Pro Tools können auch so 
eingestellt werden, dass sie sich auf folgende 
Elemente auswirken:

• Main-Stummschaltung

• Solo

• Send Level 

• Send Mute

Einschränkungen beim Gruppieren

Die folgenden Parameter werden von 
Gruppierungen nicht beeinflusst:

• Voice-Zuweisung

• Ausgangszuweisung

• Einfügen von Plug-Ins

• Elastic Audio-Plug-Ins

Wählbare Group-Attribute
Sie haben folgende Möglichkeiten, auszuwählen, 
welche Parameter oder Attribute in Gruppen 
gekoppelt werden:

• Machen Sie eine Gruppe zu einer Edit-Gruppe, 
einer Mix-Gruppe oder beidem 
(Mix/Edit-Gruppe).

• Nutzen Sie Mix-Gruppen und Mix/Edit-Gruppen, 
indem Sie aus einer Liste von Attributen für die 
Gruppe auswählen.

• Nutzen Sie Mix-Gruppen (nur in Pro Tools HD), 
indem Sie wählen, ob die ausgewählten Attribute 
global für alle Gruppen oder nur für einzelne 
Gruppen gelten sollen.

Koppeln von Mix-Gruppen und Edit-
Gruppen

Mit der Link Mix and Edit Group Enables-Option 
koppeln Sie die Aktivierung von Gruppen im Mix- 
und Edit-Fenster. Pro Tools ermöglicht Ihnen das 
Erstellen von Gruppen, die sowohl Mix- als auch Edit-
Gruppe sind. Es gibt jedoch auch Fälle, in denen eine 
gleichzeitige Aktivierung nicht erwünscht ist. So ist es 
etwa manchmal nützlich, beim Mischen im Mix-
Fenster mit großen, verschachtelten Gruppen zu 
arbeiten. Im Edit-Fenster oder in einem MIDI Editor-
Fenster hingegen müssen Editiervorgänge oft 
innerhalb kleinerer Gruppen vorgenommen werden. 
Wenn Sie die Link Mix and Edit Group Enables-Option 
deaktivieren, können Sie in den zwei Fenstern mit 
verschiedenen Gruppen arbeiten.

Wenn in Pro Tools HD das Main-Pan-
Attribut für Gruppen aktiviert ist, gilt das 
Gruppenverhalten für die Steuerelemente für 
Kopplung, umgekehrte Kopplung (vorn), 
umgekehrte Kopplung (hinten) und 
umgekehrte Kopplung (vorn/hinten) in 
Stereo- und Mehrkanal-Panner-Fenstern.
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So heben Sie die Kopplung von Mix-Gruppen und 
Edit-Gruppen auf:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing. 

2 Deaktivieren Sie die Link Mix and Edit Group 

Enables-Option. 

3 Klicken Sie auf OK.

Mix-Gruppen und VCA Master
(Nur Pro Tools HD)

Eine vorhandene Mix-Gruppe kann einem VCA 
Master zugeordnet werden. Auch eine neue Mix-
Gruppe kann einem VCA Master zugeordnet 
werden, während sie erstellt wird. Einem VCA 
Master kann jeweils nur eine Gruppe zugewiesen 
werden. Ein VCA Master kann keine Gruppe 
steuern, die sich selbst enthält.

Steuerelemente für Gruppen
Menüs und Befehle für das Erstellen und Ändern von 
Gruppen sind über folgende Elemente verfügbar:

• Gruppenliste

• Gruppennamen in der Groups-Liste

• Gruppen-ID-Anzeige auf einer Spur

• Menü Track > Group

Die Groups-Liste
Sie finden die Pro Tools-Gruppierfunktionen für 
Spuren in der Groups-Liste auf der linken Seite des 
Mix-, Edit- und MIDI Editor-Fensters. Dieses 
Scroll-Fenster enthält die Namen aller Gruppen in 
Ihrer Session sowie ein Popup-Menü, über das Sie 
Befehle zum Gruppieren aufrufen können. Über 
dieses Menü können Sie Gruppen auswählen und 
aktivieren.

Standardmäßig gibt es in jeder Session eine 
Gruppe mit dem Namen All, die sämtliche Spuren 
in der Session enthält. Die Gruppe All kann nicht 
bearbeitet oder gelöscht werden.

Weitere Informationen zur Zuweisung von 
Gruppen zu VCA Mastern finden Sie unter 
„Zuweisen von Gruppen zu VCA Mastern“ 
auf Seite 988.

Gruppenliste

Menü der Groups-Liste

Zum Auswählen 
einer Gruppe 
durch Eingabe 
ihres Buchstabens 
hier klicken

Zum Aktivieren 
einer bestimmten 
Gruppe hier 
klicken 

Zum Aus-
wählen von 
Gruppen-
mitgliedern 
auf dem 
Bildschirm 
hier klicken

Groups-Liste 
ein-/ausschalten

Gruppen-
IDs

Colors
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Schaltfläche zum Ein-/Ausblenden der 
Tracks-Liste/Groups-Liste

So zeigen Sie die Groups-Liste (und die Tracks-
Liste) an:

 Klicken Sie für die Spuren, die Sie im Mix-, 
Edit- oder MIDI Editor-Fenster ausblenden 
möchten, auf die Schaltfläche für das 
Einblenden/Ausblenden der Tracks-
Liste/Groups-Liste.

Gruppen-ID

Links neben jedem Namen in der Groups-Liste 
befindet sich ein Buchstabe, der seine Gruppen-ID 
(„a“ bis „z“) angibt.

Gruppensymbole

Links neben jeder Gruppen-ID („a“ bis „z“) befindet 
sich ein Symbol, das anzeigt, ob eine Gruppe im 
aktiven Fenster (Edit oder Mix) ausgewählt ist. 
Wie in der folgenden Abbildung gezeigt, gibt es drei 
Typen von Gruppensymbolen:

Diese Symbole haben die folgende Bedeutung:

Ausgefüllter Kreis – gibt an, dass aktuell alle 
Mitglieder der Gruppe ausgewählt sind, jedoch 
keine Elemente, die nicht zur Gruppe gehören.

Leerer Kreis – gibt an, dass derzeit nur einige der 
Mitglieder der Gruppe ausgewählt sind.

Kreis mit einem Punkt in der Mitte – gibt an, dass 
alle Mitglieder der Gruppe sowie weitere, nicht zur 
Gruppe gehörende Elemente ausgewählt sind.

Menü der Groups-Liste

Das Popup-Menü oben in der Groups-Liste bietet 
die folgenden Funktionen:

New Group – führt den Befehl Track > Group aus.

Display – liefert Befehle, um nur Edit-Gruppen, 
nur Mix-Gruppen oder alle Gruppen (Edit, Mix 
und Mix/Edit) anzuzeigen.

Suspend All Groups – setzt das Gruppenverhalten 
für alle Mix- und Edit-Gruppen außer Kraft.

Modify Groups – öffnet das Group-Dialogfeld, wenn 
Sie nur vorhandene Gruppen ändern möchten.

Delete Active Groups – löscht nur momentan 
aktive Gruppen.

Gruppensymbole

Leerer Kreis

Ausgefüllter 

Kreis

Kreis mit einem 

Punkt in der Mitte

Menü der Groups-Liste
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Popup-Menüs für Gruppennamen 
und Gruppen-ID-Anzeigen
Wenn Sie in der Groups-Liste mit der rechten 
Maustaste auf einen Gruppennamen klicken oder 
auf eine Gruppen-ID-Anzeige in einer Spur 
klicken, haben Sie über ein Popup-Menü Zugriff 
auf folgende Befehle:

Tracks – zeigt die Spurmitgliedschaft in der 
Gruppe an.

Attributes – zeigt Attribute einer Gruppe an.

Modify – öffnet das Group-Dialogfeld, wenn Sie 
nur vorhandene Gruppen ändern möchten.

Duplicate – öffnet das Group-Dialogfeld für das 
Duplizieren von Gruppen.

Delete – löscht eine einzelne Gruppe.

Select Tracks in Group – wählt Spuren in der 
Gruppe aus.

Show/Hide Tracks in Group – blendet Spuren in 
der aktuellen Gruppe ein bzw. aus.

Show Only Tracks in Group – zeigt nur die 
Spuren in der Gruppe an, alle anderen Spuren sind 
ausgeblendet.

Show All Tracks – zeigt alle Spuren in der Session 
an.

Popup-Menü eines Gruppennamens

Popup-Menü einer Gruppen-ID-Anzeige
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Group-Dialogfeld 
Zum Erstellen oder Ändern von Gruppen – ob nun 
mit der Groups-Liste, der Gruppen-ID-Anzeige 
einer Spur oder über den Menübefehl Track > 
Group – verwenden Sie das Group-Dialogfeld.

Im Group-Dialogfeld können Sie neue Gruppen 
erstellen und Gruppen Attribute zuweisen.

Group-Dialogfeld in Pro Tools HD

In Pro Tools HD verfügt das Group-Dialogfeld 
über drei Registerkarten:

Spuren – hier können Sie Spuren der aktuellen 
Gruppe hinzufügen bzw. daraus entfernen.

Attribute – hier können Sie auswählen, welche 
Parameter für die aktuelle Mix- oder Mix/Edit-
Gruppe gekoppelt sein sollen.

Globals – hier können Sie Parameter als Vorlage 
auswählen, die dann durch Auswahl der Follow 
Globals-Option auf einzelne Gruppen angewendet 
werden kann.

Group-Dialogfeld in Pro Tools

In Pro Tools verfügt das Group-Dialogfeld über 
eine Registerkarte.

Group-Dialogfeld (Pro Tools HD)

Group-Dialogfeld (Pro Tools)
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Gruppen

Erstellen von Gruppen
Sie können die Spuren auswählen, die Sie einer 
Gruppe hinzufügen möchten, bevor Sie diese 
erstellen, oder Spuren einer Gruppe hinzufügen oder 
daraus entfernen, nachdem sie erstellt wurde.

Erstellen von Gruppen in Pro Tools HD

So erstellen Sie eine Gruppe in Pro Tools HD:

1 Wählen Sie die Spuren aus, die Sie in die 
Gruppe einschließen möchten. (Wenn Sie zu 
diesem Zeitpunkt keine Spuren auswählen, 
können Sie dies später nachholen.)

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Group.

• Wählen Sie New Group aus dem Menü der 
Groups-Liste.

3 Geben Sie einen Namen für die Gruppe ein.

4 Wählen Sie die Art der zu erstellenden Gruppe 
aus: Edit, Mix oder Mix/Edit.

5 Wählen Sie im ID-Popup-Menü eine Gruppen-ID. 
Vier Bänke mit je 26 IDs sind verfügbar: a–z, 

2a–z, 3a–z, 4a–z. (Wenn Sie keine Gruppen-ID 
wählen, weist Pro Tools einer neuen Gruppe 
automatisch die nächste verfügbare ID zu.) 

6 Klicken Sie im Group-Dialogfeld auf „Tracks“ 
und führen Sie eine der folgenden Aktionen aus:

• Um der Gruppe die derzeit in der Session 
ausgewählten Spuren hinzuzufügen, klicken Sie 
auf die Add-Schaltfläche unten im 
Group-Dialogfeld.

• Um der Gruppe Spuren hinzuzufügen, wählen Sie 
die Spurnamen aus der Available-Spurenliste und 
klicken Sie auf Add oder drücken Sie die Taste A 
auf der Computertastatur.

• Um Spuren aus der Gruppe zu entfernen, wählen 
Sie die Spurnamen aus der Currently In Group-
Spurenliste und klicken Sie auf Remove oder 
drücken Sie die Taste R auf der 
Computertastatur.

• Doppelklicken Sie auf die Spurnamen in einer 
der Listen, um sie in die jeweils andere Spalte zu 
verschieben.

• Um alle Spuren in der Gruppe durch Spuren zu 
ersetzen, die derzeit in der Session ausgewählt 
sind, klicken Sie auf die Replace-Schaltfläche 
unten im Group-Dialogfeld.

7 Wenn die Gruppe eine Mix- oder eine Mix/Edit-
Gruppe ist, gehen Sie folgendermaßen vor:

• Legen Sie die Attribute für die Gruppe fest (siehe 
„Einstellen von Gruppenattributen“ auf Seite 264).

• Wenn Sie die Gruppe einem verfügbaren VCA 
zuordnen möchten, wählen Sie die VCA Master-
Spur im VCA-Popup-Menü aus.

8 Klicken Sie auf OK.

Erstellen von Gruppen in Pro Tools

So erstellen Sie eine Gruppe in Pro Tools:

1 Wählen Sie die Spuren aus, die Sie in die 
Gruppe einschließen möchten. (Wenn Sie zu 
diesem Zeitpunkt keine Spuren auswählen, 
können Sie dies später nachholen.)

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Group.

• Wählen Sie New Group aus dem Menü der 
Groups-Liste.

Sie können in jeder der Listen bei gedrückter 
Umschalttaste auf Spurnamen klicken, um einen 
Bereich von Spuren auszuwählen. Um mehrere 
nicht nebeneinander liegende Spurnamen 
auszuwählen, klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf jeden 
einzelnen Spurnamen.
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3 Geben Sie einen Namen für die Gruppe ein.

4 Wählen Sie die Art der zu erstellenden Gruppe 
aus: Edit, Mix oder Mix/Edit.

5 Wählen Sie im ID-Popup-Menü eine Gruppen-ID. 
Vier Bänke mit je 26 IDs sind verfügbar: a–z, 
2a–z, 3a–z, 4a–z. (Wenn Sie keine Gruppen-ID 
wählen, weist Pro Tools einer neuen Gruppe 
automatisch die nächste verfügbare ID zu.) 

6 Sie haben folgende Möglichkeiten:

• Um der Gruppe die derzeit in der Session 
ausgewählten Spuren hinzuzufügen, klicken Sie 
auf die Add-Schaltfläche unten im 
Group-Dialogfeld.

• Um der Gruppe Spuren hinzuzufügen, wählen Sie 
die Spurnamen aus der Available-Spurenliste und 
klicken Sie auf Add oder drücken Sie die Taste A 
auf der Computertastatur.

• Um Spuren aus der Gruppe zu entfernen, wählen 
Sie die Spurnamen aus der Currently In Group-
Spurenliste und klicken Sie auf Remove oder 
drücken Sie die Taste R auf der 
Computertastatur.

• Doppelklicken Sie auf die Spurnamen in einer 
der Listen, um sie in die jeweils andere Spalte zu 
verschieben.

• Um alle Spuren in der Gruppe durch Spuren zu 
ersetzen, die derzeit in der Session ausgewählt 
sind, klicken Sie auf die Replace-Schaltfläche 
unten im Group-Dialogfeld.

7 Wählen Sie unter Linked Within Groups die 
Elemente aus, die innerhalb von Gruppen 
gekoppelt sein sollen (Mutes, Solos, Send 

Mute, Send Levels).

8 Klicken Sie auf OK.

Ändern von Gruppen

So ändern Sie eine Gruppe:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Modify Groups aus dem Menü der 
Groups-Liste. 

• Klicken Sie im Mix-Fenster auf die Gruppen-
ID-Anzeige auf einer Spur und wählen Sie im 
Popup-Menü die Modify-Option. 

• Klicken Sie mit der rechten Maustaste auf den 
Gruppennamen in der Groups-Liste und wählen 
Sie Modify.

2 Wählen Sie im Group-Dialogfeld im ID-Popup-
Menü die Gruppe aus, die Sie ändern möchten.

3 Sie können folgende Elemente für die aktuelle 
Gruppe ändern:

• Gruppenname

• Gruppenart (Edit, Mix oder Mix/Edit)

• VCA-Status (nur Pro Tools HD)

• Follows Global-Status (nur Pro Tools HD)

• Spurmitgliedschaft

• Attributes (nur Pro Tools HD)

• Linked Within Group-Elemente 
(nur Pro Tools HD)

4 Klicken Sie auf OK.

Sie können in jeder der Listen bei gedrückter 
Umschalttaste auf Spurnamen klicken, um 
einen Bereich von Spuren auszuwählen. Um 
mehrere nicht nebeneinander liegende 
Spurnamen auszuwählen, klicken Sie bei 
gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf jeden einzelnen 
Spurnamen.
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So ändern Sie die Einstellungen für die Gruppe 
„All“ in Pro Tools HD:

1 Klicken Sie in der Groups-Liste mit der rechten 
Maustaste auf den Gruppennamen „All“ und 
wählen Sie im Popup-Menü Modify.

2 Wählen Sie im Group-Dialogfeld Edit, Mix oder 
Mix/Edit, um die Einstellungen für die Gruppe 
„All“ zu ändern. Wenn Sie nur Edit oder Mix 
wählen, gilt die Gruppe „All“ nur für 
diese Gruppenart. 

3 Für Mix- oder Mix/Edit-Gruppen können Sie 
folgende Einstellungen ändern:

• Follow Global-Status

• Attribute

4 Klicken Sie auf OK. 

So ändern Sie die Einstellungen für die Group 
„All“ in Pro Tools:

1 Klicken Sie in der Groups-Liste mit der rechten 
Maustaste auf den Gruppennamen „All“ und 
wählen Sie im Popup-Menü Modify.

2 Wählen Sie im Group-Dialogfeld Edit, Mix oder 
Mix/Edit, um die Einstellungen für die Gruppe „All“ 
zu ändern. Wenn Sie nur Edit oder Mix wählen, gilt 
die Gruppe „All“ nur für diese Gruppenart. 

3 Für Mix- oder Mix/Edit-Gruppen können Sie 
folgende Linked Within Groups-Optionen ändern:

• Mutes 

• Solos 

• Send-Mutes 

• Send Levels 

4 Klicken Sie auf OK. 

Löschen von Gruppen
Sie können eine oder alle Gruppen 
gleichzeitig löschen.

Führen Sie einen der folgenden Schritte aus, 
um eine einzelne Gruppe zu löschen:

 Klicken Sie im Mix-Fenster auf die Gruppen-
ID-Anzeige auf einer Spur und wählen Sie 
im Popup-Menü die Delete-Option. 

 Klicken Sie mit der rechten Maustaste auf den 
Gruppennamen in der Groups-Liste und wählen 
Sie im Popup-Menü die Delete-Option.

Modify ALL Group-Dialogfeld (in Pro Tools HD)

Modify ALL Group-Dialogfeld (in Pro Tools)

Das Löschen einer Gruppe lässt sich nicht 
rückgängig machen.
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So löschen Sie alle momentan aktiven Gruppen:

 Wählen Sie im Menü der Groups-Liste die 
Delete Active Groups-Option. 

Duplizieren von Gruppen
Sie können eine Gruppe duplizieren und 
ihre Einstellungen ändern, um rasch einen 
Mix einzurichten. 

So duplizieren Sie eine Gruppe:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Gruppen-ID-Anzeige auf 
einer Spur und wählen Sie im Popup-Menü die 
Duplicate-Option. 

• Klicken Sie mit der rechten Maustaste auf den 
Gruppennamen in der Groups-Liste und wählen 
Sie im Popup-Menü die Duplicate-Option.

2 Sie können folgende Elemente für die aktuelle 
Gruppe ändern:

• Gruppenname

• Gruppenart (Edit, Mix oder Mix/Edit)

• VCA-Status (nur Pro Tools HD)

• Follows Global-Status (nur Pro Tools HD)

• Spurmitgliedschaft

• Attributes (nur Pro Tools HD)

• Linked Within Group-Elemente (nur Pro Tools)

3 Klicken Sie auf OK. 

Einstellen von 
Gruppenattributen
(Nur Pro Tools HD)

Beim Erstellen einer Mix- oder Mix/Edit-Gruppe 
können Sie die Mix-Fensterparameter auswählen, 
die für diese Gruppe gekoppelt werden. Diese 
gekoppelten Parameter sind die Attribute der 
Gruppe.

Sie können Attribute auf der Globals-Registerkarte 
auswählen und anschließend für einzelne Gruppen 
festlegen, dass sie den Global-Einstellungen 
folgen, oder Sie können Attribute einzeln für 
Gruppen auswählen. 

Auswählen der Attribute auf der 
Globals-Registerkarte
So wählen Sie Attribute auf der Globals-Registerkarte:

1 Klicken Sie beim Erstellen oder Ändern 
einer Gruppe im Group-Dialogfeld auf die 
Globals-Registerkarte.

Die Gruppe „All“ kann nicht gelöscht 
werden.

Globals-Registerkarte des Group-Dialogfelds
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2 Wählen Sie den Basissatz von Gruppenattributen 
in Ihrer Session aus. 

3 Klicken Sie auf OK, um die Gruppe und die 
neuen globalen Einstellungen zu speichern.

So wählen Sie Attribute für eine einzelne Gruppe aus:

1 Gehen Sie folgendermaßen vor, während Sie 
eine Mix- oder Mix/Edit-Gruppe erstellen oder 
ändern:

• Klicken Sie im Group-Dialogfeld auf 
„Attributes“ und wählen Sie die Attribute aus, 
die Sie koppeln möchten. 

• Aktivieren Sie die Follow Globals-Option, wenn 
für die Gruppe der Basissatz von Attributen 
gelten soll. Die Attributes-Registerkarte wird 
abgeblendet, um anzuzeigen, dass für die 
Gruppe die auf der Globals-Registerkarte 
ausgewählten Einstellungen gelten.

2 Klicken Sie auf OK, um die Einstellungen 
zu speichern.

Auswählen von 
Gruppenattributen
Die folgenden Attribute können für die Global-
Einstellungen und für einzelne Gruppen 
ausgewählt werden.

Spureinstellungen:

• Main-Lautstärke

• Main-Stummschaltung

• Main-Panorama

• Main-LFE-Pegel

Insert-Einstellungen (Inserts A–J):

• Plug-In-Einstellungen

• Insert Bypass

Informationen zum Auswählen von 
Attributen finden Sie unter „Auswählen von 
Gruppenattributen“ auf Seite 265.

Informationen zum Auswählen von 
Attributen finden Sie unter „Auswählen von 
Gruppenattributen“ auf Seite 265.

Attributes-Registerkarte des Group-Dialogfelds
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Send-Einstellungen (Sends A–J):

• Send Level

• Send Mute

• Send Pan

• Send-LFE-Pegel

Mix-Attribute:

• Record Enable

• Input Monitoring

• Solos

• Automationsmodus

• HEAT-Funktion Pre/Post (nur Pro Tools|HDX)

• HEAT-Funktion Bypass (nur Pro Tools|HDX)

Zur Auswahl der Attribute für eine Gruppe wählen 
Sie eine der folgenden Methoden:

 Wählen Sie individuelle Attribute.

 Um alle Attribute aus- oder abzuwählen, klicken 
Sie bei gedrückter Alt- (Windows) bzw. Wahl- 
(Mac) und Umschalttaste auf ein Attribut.

 Um alle Attribute für einen einzigen Send oder 
Insert (für eine Zeile) aus- oder abzuwählen, 
klicken Sie bei gedrückter Windows- (Windows) 
bzw. Befehls- (Mac) und Umschalttaste auf ein 
beliebiges Attribut in dieser Zeile. 

 Um alle Attribute für ein einziges Steuerelement 
für alle Sends, alle Inserts oder für die vier 
Spureinstellungen (in einer Spalte) aus- oder 
abzuwählen, klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Befehlstaste (Mac) auf ein 
Attribut in dieser Spalte. 

Speichern von Voreinstellungen 
für Gruppenattribute
Sie können sechs Gruppen-Voreinstellungen 
definieren, die Sie auf der Attributes- oder Globals-
Registerkarte abrufen können, wenn Sie eine Mix- 
oder Mix/Edit-Gruppe erstellen oder ändern. 

So speichern Sie die aktuellen 
Attributeinstellungen als Gruppen-Voreinstellung:

1 Klicken Sie im Group-Dialogfeld auf Save. 
(Die Follow Globals-Option muss deaktiviert 
sein, damit eine Einstellung der Attributes-
Registerkarte gespeichert werden kann.)

2 Wählen Sie im Location-Popup-Menü des Save 
Group Settings-Dialogfelds eine der sechs 
Speicherpositionen für Voreinstellungen aus 
und klicken Sie auf Save.

So rufen Sie eine Gruppen-Voreinstellung ab:

 Klicken Sie auf die entsprechende 
Voreinstellungsschaltfläche (1–6) im Group-
Dialogfeld. (Die Follow Globals-Option muss 
deaktiviert sein, damit eine Einstellung der 
Attributes-Registerkarte abgerufen 
werden kann.)

Speichern einer Gruppen-Voreinstellung

Auswählen einer Speicherposition für die 
Gruppeneinstellung 

Um die aktuellen Attributeinstellungen direkt an 
einer Voreinstellungsposition zu speichern, halten 
Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und klicken Sie auf 
die Voreinstellungsschaltfläche.

Abrufen einer Gruppen-Voreinstellung
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Aktivieren von Gruppen
Editiervorgänge werden nicht auf Mitglieder einer 
Gruppe angewendet, die in der Tracks-Liste 
ausgeblendet sind. Vorgänge im Mix-Fenster (mit 
Ausnahme des Scharfschaltens von Spuren) 
werden hingegen auch auf ausgeblendete Spuren 
angewendet.

Sie können in Pro Tools separate Gruppen zum 
Editieren und Mischen erstellen. Diese Option 
wird bei Verwendung des New Group-Befehls 
eingestellt. Sie können Gruppen, die sowohl für 
das Editieren als auch zum Mischen erstellt 
wurden, auch entkoppeln.

So aktivieren Sie eine Gruppe:

 Klicken Sie in der Groups-Liste auf den Namen 
der zu aktivierenden Gruppe. 
Der Gruppenname wird markiert, um 
anzuzeigen, dass die Gruppe aktiviert ist.

Um zusätzliche Gruppen zu aktivieren, klicken Sie in 
der Groups-Liste auf die entsprechenden Namen. 

Wenn Sie den Fader eines Gruppenmitglieds 
bewegen, bewegen sich die Fader der übrigen 
Mitglieder der Gruppe relativ dazu. Wenn ein Fader 
zu mehreren Gruppen gehört und die Gruppen beim 
Verschieben von Fadern in Konflikt geraten, folgt der 
Fader der obersten, d. h. der übergeordneten Gruppe, 
zu der er gehört.

So deaktivieren Sie eine Gruppe:

 Klicken Sie in der Groups-Liste auf den Namen 
der Gruppe, die deaktiviert werden soll. 
Der Gruppenname erscheint nicht mehr 
hervorgehoben, um anzuzeigen, dass die 
Gruppe deaktiviert ist.

Auswählen von Gruppen über 
die Tastatur
Der Groups-Listen-Tastaturfokus ermöglicht die 
Eingabe eines Gruppen-ID-Buchstabens zum 
automatischen Ändern des Aktivierungsstatus der 
Gruppe.

 Im Mix-Fenster ist der Groups-Listen-
Tastaturfokus immer aktiviert. 

 Im Edit-Fenster müssen Sie ihn vor der 
Verwendung aktivieren.

Zur Aktivierung des Edit Groups-Listen-
Tastaturfokus wählen Sie eine der 
folgenden Methoden:

 Klicken Sie in der oberen rechten Ecke der Edit 
Groups-Liste auf die Schaltfläche für den 
Tastaturfokus.

 Drücken Sie Strg + Alt + 3 (Windows) bzw. 
Befehl + Wahl + 3 (Mac).

So aktivieren bzw. deaktivieren Sie Gruppen mithilfe 
des Edit and Mix Groups-Listen-Tastaturfokus:

 Geben Sie bei aktiviertem Groups-Listen-
Tastaturfokus den Buchstaben für die ID der 
Gruppe ein (a–z), um die entsprechende Gruppe 
automatisch zu aktivieren bzw. deaktivieren.

Aktivierter Groups-Listen-Tastaturfokus



Pro Tools-Referenzhandbuch268

Temporäres Isolieren der 
Steuerung eines Elements vom 
Gruppenvorgang
Sie können die Steuerung eines Gruppenelements 
temporär vom Gruppenvorgang abkoppeln, indem 
Sie mit der rechten Maustaste auf das Element 
klicken.

Die folgenden Elemente können vom 
Gruppenvorgang isoliert werden:

• Panoramaregler (nur Pro Tools HD)

• Kanal-Scharfschaltung (nur Pro Tools HD)

• Kanal-TrackInput (nur Pro Tools HD)

• Send-Panoramaregler 

• Kanallautstärke-Fader

• Kanal-Panoramaregler

• Schaltfläche für Kanal-Stummschaltung

• Schaltfläche für Kanal-Soloschaltung

• Schaltfläche für Kanal-Scharfschaltung

• Schaltfläche für Kanal-TrackInput

• Send-Fader

• Send-Panoramaregler

Gruppierte Steuerelement-
Offsets
Wenn die folgenden Steuerelemente mit Offsets 
gruppiert sind und an deren äußerste Werte 
verschoben werden, bleiben relative Offsets 
erhalten, wenn die Steuerelemente von den 
äußersten Werten zurückbewegt werden:

• Main-Lautstärke

• Main-Panorama (nur Pro Tools HD)

• Send Level

• Send Pan

Wenn beispielsweise ein gruppierter Lautstärke-
Fader auf seinen Maximalwert bewegt wird, 
so „merken“ sich alle anderen Fader in dieser 
Gruppe, die höhere Werte hatten, ihren relativen 
Offset, wenn der erste Fader wieder nach unten 
bewegt wird.

In Automation-Darstellungen wird dieser 
„Overflow“ auf der Automations-Playlist durch 
blaue Automation Breakpoints an den äußersten 
Werten der Playlist angezeigt.

Einstellen von gruppierten Pan-
Steuerelementen auf das 
Ignorieren von Offsets
Standardmäßig bleiben Offsets für gruppierte 
Pan-Steuerelemente erhalten. In einigen 
Arbeitsabläufen ist es aber wünschenswert, dass 
gruppierte Pan-Steuerelemente absoluten Werten 
entsprechen, anstatt die Offsets beizubehalten.

So stellen Sie gruppierte Pan-Steuerelemente so 
ein, dass Offsets ignoriert werden:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Wählen Sie die Use Absolute Pan Linking-Option

Wenn diese Option aktiviert ist, rasten gruppierte 
Pan-Steuerelemente am absoluten Wert des 
Steuerelements an, das angepasst wird.

Sie können auch das Gruppenverhalten 
einer Spur vorübergehend aufheben, indem 
Sie die Ctrl-Taste (Mac) bzw. Windows-
Taste (Windows) gedrückt halten und auf 
eine Gruppenfunktion klicken.
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Kapitel 15: Clipliste

Im Edit-Fenster werden alle Audioclips, MIDI-
Clips und Clipgruppen in einer einzelnen, 
umfassenden Clipliste angezeigt. 

Alle Clips jeglicher Art, die aufgenommen, 
importiert oder durch Editieren erzeugt werden, 
erscheinen in der Clipiste. Aus der Liste können 
Elemente auf Spuren gezogen und in beliebiger 
Reihenfolge angeordnet werden. Sie können auch 
eine Vorschau der Audio- und MIDI-Clips sowie 
von Clipgruppen in der Clipliste anzeigen.

Da Clipinformationen sehr lang werden können, 
kann die Clipliste gescrollt oder in ihrer Größe 
verändert werden. 

Menü der Clipliste
Das Menü der Clipliste bietet Tools zum Suchen, 
Auswählen, Sortieren, Exportieren, Löschen und 
Verwalten von Elementen in der Clipliste.

So greifen Sie auf das Menü der Clipliste zu:

 Klicken Sie im Edit-Fenster auf das Menü 
der Clipliste.

Clipliste

Schaltfläche zum Ein-/Ausblenden der Clipliste

Hier ziehen zum Ändern 
der Breite der Clipliste

Clipliste (Menü)

Tastaturfokus Benutzen Sie die Clipliste als Speicherort 
für Ihre bevorzugten Audio-Loops und 
MIDI-Clips. Speichern Sie die Session als 
Vorlage (siehe „Session-Vorlagen“ auf 
Seite 169), damit Sie diese Clips auch für 
weitere Sessions verwenden können.

Clipliste (Menü)
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Anzeigen von Clips in der Clipliste
In der Clipliste können alle Cliparten (Audio, MIDI, 
Video, Gruppen, automatisch erzeugt) oder nur 
bestimmte Arten angezeigt werden. Dies ist hilfreich, 
wenn Sie die Cliparten, an denen Sie arbeiten 
möchten, zum Bearbeiten und Arrangieren isolieren 
möchten. Wenn Sie beispielsweise Clipgruppen 
arrangieren, können Sie die Anzeige der Clipliste auf 
Clipgruppen begrenzen.

So blenden Sie bestimmte Cliparten in der Clipliste 
ein bzw. aus:

 Klicken Sie auf das Cliplisten-Menü (oben in der 
Clipliste) und wählen Sie Show. Im Untermenü 
können Sie dann die Clipart, die Sie anzeigen oder 
ausblenden möchten, auswählen oder die 
entsprechende Auswahl aufheben. 

Audio – blendet Audioclips in der Clipliste ein 
oder aus.

MIDI –. blendet MIDI-Clips in der Clipliste ein 
oder aus.

Video – blendet Video-Clips in der Clipliste ein 
oder aus.

Gruppen – blendet Clipgruppen in der Clipliste ein 
oder aus.

Auto-Created – blendet automatisch erstellte Clips 
(aller Art) in der Clipliste ein oder aus. Diese Clips 
entstanden als Nebenprodukt durch das Schneiden, 
Einfügen und Trennen anderer Clips. Da die Anzahl 
dieser automatisch erstellten Clips erheblich 
anwachsen kann, verhindern Sie durch das 
Ausblenden (indem Sie die Auswahl der Option 
aufheben), dass Sie durch eine unnötig lange Clipliste 
scrollen müssen. 

In der Clipliste werden die auf vollständige Dateien 
verweisenden Audioclips fett dargestellt. Die 
Anzeige von Stereo- und Mehrkanal-Clips kann 
erweitert werden, um einzelne Kanäle anzuzeigen.

Wenn in den Editing-Voreinstellungen die Option 
Clip List Selection Follows Edit Selection aktiviert 
ist und Sie in der Clipliste einen Clip oder eine 
Clipgruppe auswählen, wird dieser für jede Spur 
ausgewählt, bei der er in den zugewiesenen 
Playlists vorhanden ist. Genauso wird durch das 
Auswählen eines Clips oder einer Clipgruppe auf 
einer Spur des Clips oder die Clipgruppe in der 
Clipliste ausgewählt.

Anzeigen von Dateiinformationen 
für Audioclips
Zusätzlich zu Clipnamen können in der Clipliste 
Informationen zum Farbcode des Clips, zur Art 
(Audio, MIDI und Clipgruppe), zur Zeitbasis, 
zur Elastic Audio-Bearbeitung und zur 
übergeordneten Datei angezeigt werden:

Timebase – zeigt die Zeitbasis (Samples oder 
Ticks) für Audio- und MIDI-Clips sowie 
Clipgruppen an.

Farbe – zeigt für Spuren die farbliche 
Kennzeichnung an, die mit der Default Clip Color 
Coding-Option auf der Display Preferences-
Registerkarte oder über die Farbpalette zugeordnet 
wurde.

Bearbeitungsstatus – zeigt das Warp-Anzeige-
Symbol an, wenn auf diesen Clip die Elastic 
Audio-Verarbeitung angewendet wurde.

Guitar Settings (nur Eleven Rack) – zeigt das 
Eleven Rack-Symbol an, falls Gitarreneinstellungen 
in den Clip eingebettet sind.

File Type – zeigt das Dateityp-Symbol für Audio- 
und MIDI-Clips sowie Clipgruppen an.

Das Ausblenden von mit der Auto-Created-
Option erstellten Clips ist beim Import von 
Clipgruppen (oder REX-Dateien als 
Clipgruppen) empfehlenswert, da diese 
Dateitypen unter Umständen so viele 
einzelne Clips enthalten, dass die Clipliste 
nur mühsam zu lesen ist.
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File Name – zeigt den Namen der übergeordneten 
Datei an.

Disk Name – zeigt den Namen der Festplatte an, 
auf der sich die referenzierte Datei befindet.

Full Path – zeigt den vollständigen Verzeichnispfad 
der übergeordneten Datei des Clips an.

Kanalname – zeigt den Kanalnamen für 
Audiodateien an, die von transportablen 
Rekordern importiert wurden.

Szene und Take – zeigt die Szene und den Take 
für Audiodateien an, die von transportablen 
Rekordern importiert wurden.

Pro Tools zeigt standardmäßig nur den Clipnamen 
in der Clipliste an. 

Sortieren und Durchsuchen 
der Clipliste
Da die meisten Sessions zahlreiche Clips enthalten, 
kann es schwierig sein, einen bestimmten Clip in der 
Clipliste zu finden. Mit Pro Tools können Sie Clips in 
der Clipliste sortieren und suchen, um gewünschte 
Clips schnell zu finden.

Sortieren von Clips

So sortieren Sie Clips in der Clipliste:

1 Klicken Sie auf das Cliplisten-Menü (oben in 
der Clipliste) und wählen Sie Sort By. 

2 Wählen Sie aus dem Untermenü eine 
Sortiergrundlage aus. Für Audio- und MIDI-Clips 
sind unterschiedliche Optionen verfügbar. Siehe 
„Sort By-Optionen“ auf Seite 271.

3 Um festzulegen, ob Clips in auf- oder 
absteigender Reihenfolge angezeigt werden, 
klicken Sie im Cliplisten-Menü auf Sort By und 
wählen Sie Ascending (für aufsteigend) oder 
Descending (für absteigend) aus.

Sort By-Optionen
Mit den Sort by-Optionen können Sie Clips 
sortieren, damit Sie auch bei einer großen Anzahl 
von Clips einen guten Überblick behalten.

Audioclips können nach folgenden Kategorien 
sortiert werden:

• Clipart

• Name

• Length

• Originalzeitstempel

• Benutzerzeitstempel

• Timebase

• Start in Parent

Clipliste mit Clips und angezeigten Dateiinformationen

Beim Editieren kann die Clipliste mit 
automatisch erstellten Clips überhäuft 
werden. Sie können automatisch erstellte 
Clips ausblenden, indem Sie im Cliplisten-
Menü die Show-Option auswählen und die 
Auto-Created-Option deaktivieren.
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• End in Parent

• File Name

• Dateilänge

• File Creation Date

• Dateiänderungsdatum

• Laufwerkname (nur Audio- und Clipgruppen)

• Track Format/Width

• Nach Kanalname

• By Scene and Take

• Gitarreneinstellungen

MIDI-Clips können nach folgenden Kriterien 
sortiert werden:

• Name

• Length

• Originalzeitstempel

• Benutzerzeitstempel

• Timebase

• Start in Parent

• End in Parent

Clips können auch nach Clip Type 
(Audio und MIDI) oder in aufsteigender 
(Ascending) bzw. absteigender (Descending) 
Reihenfolge sortiert werden.

Suchen von Clips
Wählen Sie den Find-Befehl, um alle Clips in einer 
Liste anzuzeigen, deren Namen ein oder mehrere 
bestimmte Worte enthalten.

So suchen Sie Clips in der Clipliste und zeigen 
diese an:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf das Cliplisten-Menü und wählen 
Sie Find. 

• Drücken Sie Befehl + Umschalt + F (Mac) bzw. 
Strg + Umschalt + F (Windows).

2 Führen Sie im Find Clips-Dialogfeld einen der 
folgenden Schritte aus: 

• Wählen Sie By Name und geben Sie den Namen 
oder einen Teil des Namens für die Clips an, nach 
denen Sie suchen möchten. Die Suchzeichenfolge 
wird oben in der Clipliste angezeigt.

• Wählen Sie Include Subsequently Added Clips, 
um die Anzeige auf neu hinzugefügte Clips 
einzugrenzen. Ein Pluszeichen (+) erscheint 
oben in der Clipliste, um anzuzeigen, dass diese 
Option ausgewählt ist.

• Wählen Sie beide Optionen aus, um mit einer 
Liste benannter Clips zu beginnen und die 
Anzeige hinzugefügter Clips zu erlauben.

Find Clips-Dialogfeld

Gefundene Clips in der Clipliste
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Clips jeder Art, deren Namen mit dem Suchbegriff 
übereinstimmen, werden in der Clipliste angezeigt. 
Die Suchzeichenfolge wird oben in der Clipliste in 
Klammern angezeigt. 

3 Klicken Sie auf OK.

So wiederholen Sie einen vorhergehenden 
Suchvorgang:

1 Klicken Sie auf das Cliplisten-Menü und 
wählen Sie Find.

2 Klicken Sie auf den kleinen Pfeil rechts neben 
dem Textfeld im Find-Dialogfeld und wählen 
Sie eine Textzeichenfolge aus dem Suchverlauf-
Popup-Menü. 

Der Suchverlauf wird in der Session gespeichert. 

Zusätzlich zum Speichern jeder Textzeichenfolge, 
die Sie eingegeben haben, können Sie in „Find 
History“ mehrere Einträge manuell eingeben, ohne 
jeden Suchvorgang ausführen zu müssen, um Wörter 
oder Ausdrücke zu speichern. 

So kompilieren Sie einen Suchverlauf ohne 
Ausführen jedes Suchvorgangs:

1 Klicken Sie auf das Cliplisten-Menü und 
wählen Sie Find. 

2 Klicken Sie auf den kleinen Pfeil rechts neben 
dem Textfeld im Find-Dialogfeld, halten Sie die 
Maustaste gedrückt und wählen Sie das 
Element in der Suchverlaufsliste aus, vor dem 
Sie einen neuen Eintrag einfügen möchten.

3 Geben Sie den Namen oder einen Teil des Namens 
der Clips an, nach denen Sie suchen möchten.

4 Klicken Sie auf den kleinen Pfeil rechts neben 
dem Textfeld im Find-Dialogfeld, halten Sie die 
Maustaste gedrückt und wählen Sie Insert Entry 
aus dem Popup-Menü aus. 

5 Geben Sie ggf. einen anderen Eintrag ein und 
wählen Sie Insert Entry erneut aus, um der 
Suchverlaufsliste zusätzliche 
Suchzeichenfolgen hinzuzufügen. 

So entfernen Sie einen Eintrag aus dem Verlauf:

1 Wählen Sie den Eintrag aus dem Suchverlauf-
Popup-Menü, sodass er im Textfeld 
angezeigt wird.

2 Wählen Sie Remove Entry aus dem Find 

History-Popup-Menü. 

So löschen Sie den Suchverlauf:

 Wählen Sie Remove All Entries aus dem Find 

History-Popup-Menü. 

Im Find-Dialogfeld eingegebener Text 
wird in einem Suchverlauf gespeichert, 
sodass Sie vorhergehende Suchvorgänge 
schnell mit einem Minimum an neuen 
Eingaben wiederholen können.

Beispiel eines Suchverlaufs

Clipliste während eines Suchvorgangs
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Auswählen von Clips in der 
Clipliste
Sie können Clips in der Clipliste auswählen, um sie 
dann auf Spuren ziehen, mit AudioSuite-Plug-Ins 
verarbeiten oder exportieren zu können.

So wählen Sie einen Clip in der Clipliste aus oder 
heben die Auswahl auf:

 Klicken Sie auf einen nicht markierten 
Clipnamen, um ihn auszuwählen.

 Klicken Sie auf einen markierten Clipnamen, 
um ihn abzuwählen.

Führen Sie einen der folgenden Schritte aus, 
um einen Clipbereich in der Clipliste auszuwählen:

 Bewegen Sie den Mauszeiger links neben die 
Clipnamen, sodass das Fadenkreuz erscheint. 
Ziehen Sie ein Rechteck um die Clips herum, 
die Sie auswählen möchten.

 Klicken Sie auf den Namen eines Clips in der 
Clipliste und klicken Sie bei gedrückter 
Umschalttaste auf einen zusätzlichen Clipnamen.

Alle Clips, die sich zwischen dem zuerst und dem 
danach ausgewählten Clip befinden, werden 
ebenfalls ausgewählt.

So wählen Sie einen Bereich von Clips mit dem 
Fadenkreuz aus bzw. ab:

1 Bewegen Sie den Cursor links neben den Namen 
eines Clips, bis das Fadenkreuzsymbol mit einem 
kleinen Pluszeichen (+) angezeigt wird:

• Um Clips auszuwählen, sollte sich das 
Fadenkreuz links neben einem nicht markierten 
Clipnamen befinden.

• Um Clips abzuwählen, sollte sich das 
Fadenkreuz links neben einem markierten 
Clipnamen befinden.

2 Klicken Sie auf den Clipnamen und ziehen Sie 
ihn nach oben oder unten, um Clips aus- bzw. 
abzuwählen, die sich direkt über oder unter dem 
Clipnamen befinden.

Führen Sie einen der folgenden Schritte aus, 
um nicht benachbarte Clips auszuwählen oder die 
Auswahl aufzuheben:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf nicht 
markierte Clipnamen, um diese auszuwählen.

 Klicken Sie bei gedrückter Strg-Taste (Windows) 
bzw. Befehlstaste (Mac) auf markierte Clipnamen, 
um die Auswahl aufzuheben.

Mit dem Fadenkreuz ausgewählte Clips

Um mehrere, nicht benachbarte Clips in der 
Clipliste auszuwählen, halten Sie bei der 
Auswahl der Clips die Befehlstaste (Mac) 
bzw. die Strg-Taste (Windows) gedrückt.
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Auswählen von Clips über die 
Tastatur
Ist der Cliplisten-Tastaturfokus aktiviert, werden 
in Pro Tools automatisch die Clips, deren erste 
Buchstaben Sie eingeben, in der Clipliste gefunden 
und ausgewählt.

So aktivieren und verwenden Sie den Cliplisten-
Tastaturfokus:

1 Klicken Sie rechts oben in der Clipliste auf die 
Schaltfläche für den Keyboard Focus.

2 Geben Sie die ersten Buchstaben eines Clips 
ein, um diesen automatisch zu finden und 
auszuwählen. Wurde der Clip gefunden 
und ausgewählt, kann er auf eine Spur gezogen 
werden.

Werden Audioclips über die Tastatur gesucht, 
erfolgt die Auswahl nach den Namen der Clips und 
nicht nach den Namen der ihnen übergeordneten 
Audiodateien oder der Volumes, auf denen sie sich 
befinden.

Select-Optionen
Sie können in der Clipliste bestimmte Clips 
auswählen, um sie dann auf Spuren ziehen, mit 
AudioSuite-Plug-Ins verarbeiten oder exportieren 
zu können.

So wählen Sie bestimmte Clips in der Clipliste aus:

 Wählen Sie im Cliplisten-Menü erst Select und 
dann eine der Select-Optionen aus:

All – wählt alle Clips der Clipliste aus.

Unused – wählt Clips aus, die in der aktuellen 
Session in keiner Spur positioniert wurden. 
Offline-Clips werden in der Clipliste kursiv und 
grau angezeigt.

Unused Except Whole Files – wählt Clips aus, die 
in der aktuellen Session in keiner Spur positioniert 
wurden, aber umfasst keine Clips, in denen eine 
komplette Datei (Whole-File-Clip) enthalten ist. – 
Whole-File-Clips werden beim Aufnehmen oder 
Importieren von Audio, Konsolidieren bestehender 
Clips oder nicht-destruktiven Verarbeiten mit einem 
AudioSuite-Plug-In erstellt. Sie verweisen auf 
komplette Audiodateien auf Ihrer Festplatte. Diese 
Whole File-Clips werden in der Clipliste in Fettdruck 
angezeigt. 

Offline – wählt Clips aus, deren übergeordnete 
Dateien nicht gefunden werden können oder die beim 
Öffnen einer Session bzw. Importieren einer Spur 
nicht verfügbar sind. Offline-Clips werden in der 
Clipliste kursiv und grau, in Playlists hellblau mit 
kursiv gedruckten Namen angezeigt.

Aktivierter Cliplisten-Tastaturfokus
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Vorhören von Clips in der 
Clipliste
Sie können eine Vorschau der Audio- und MIDI-
Clips sowie von Clipgruppen in der Clipliste 
anzeigen. Die Vorschau entspricht dem 
Hauptabhörpfad, der in der Output-Registerkarte 
des I/O Setup-Dialogfelds angegeben wurde. 
Der Basispegel für die Vorschau wird durch den 
Pegel des dem Abhörpfad zugewiesenen Master-
Faders (oder Auxiliary-Eingangs) bestimmt.

So zeigen Sie die Vorschau eines Clips in der 
Clipliste an:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf einen Clipnamen. 

Audio-Clips sowie Clipgruppen werden über 
den angegebenen Abhörpfad wiedergegeben 
(siehe „Abhörpfade“ auf Seite 78).

Samplebasierte Clips werden in ihrem ursprünglichen 
Tempo wiedergegeben. Tickbasierte MIDI-Clips 
sowie mit Elastic Audio verarbeitete Clips werden im 
Session-Tempo wiedergegeben (das auf der Position 
des Playback-Cursors beruht). Sie können auch 
während der Session-Wiedergabe eine Vorschau der 
Clips aus der Clipliste anzeigen.

MIDI-Clips werden über die in den MIDI-
Einstellungen ausgewählte Default Thru 
Instrument-Option wiedergegeben (siehe 
„Standard-Thru-Instrument“ auf Seite 481).

Abhören diskreter Signale in 
Mehrkanalelementen
In der Clipliste werden Clips mit mehreren Kanälen 
über den im I/O Setup-Dialogfeld spezifizierten 
Abhörpfad abgehört. Signale können wie unten 
beschrieben „in-place“ („an Ort und Stelle“) oder 
über alle Ausgänge abgehört werden. 

In-Place-Abhören

Beim Abhören einer Monokomponente eines 
Monokomponenten-Clips kann der Mono-Clip 
vom entsprechenden Kanal seines übergeordneten 
Monokomponenten-Clips abgespielt werden. 
Diese Wiedergabemethode wird als In-Place-
Abhören bezeichnet.

So hören Sie „an Ort und Stelle“ ab:

1 Stellen Sie sicher, dass der Stereo- oder 
Mehrkanal-Clip in der Clipliste in erweiterter 
Darstellung angezeigt wird (sodass .L, .R und 
andere Teilkanäle zu sehen sind). 

2 Klicken Sie bei gedrückter Wahltaste (Mac) 
bzw. Alt-Taste (Windows) auf den Clip für den 
Kanal, den Sie abhören möchten. 

Abhören aller Ausgänge

Beim Abhören einer Monokomponente eines 
Monokomponenten-Clips kann der Clip 
gleichmäßig auf alle Ausgänge des Abhörpfads 
des übergeordneten Clips geroutet werden.

So hören Sie alle Kanäle des Hauptabhörpfads ab:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt- (Windows) und Umschalttaste auf das 
gewünschte Signal in der Clipliste. 

Über das Vorschaulautstärke-Steuerelement 
im Import Audio-Dialogfeld beeinflussen Sie 
die Lautstärke der Vorschau beim Abhören von 
Clips in der Clipliste.
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Stereo- und Mehrkanal-Clips 
in der Clipliste
Stereo- oder Mehrkanal-Clips werden, unabhängig 
davon, ob sie in Pro Tools importiert oder dort 
aufgenommen wurden, in der Clipliste als ein 
Eintrag angezeigt. So werden beispielsweise zwei 
Mono-Clips aus Monoquellen mit den Namen 
„Main Piano.L“ und „Main Piano.R“ als „Main 
Piano (Stereo)“ aufgelistet. Stereo- und 
Mehrkanal-Clips sind durch ein Dreieck zum 
Erweitern bzw. Reduzieren gekennzeichnet. 

Stereo- und Mehrkanal-Clips werden in der Clipliste 
standardmäßig in reduzierter Darstellung angezeigt. 
Die einzelnen Clips können durch Klicken auf den 
Pfeil zum Erweitern des Namens links neben dem 
Clip angezeigt werden.

So erweitern oder reduzieren Sie alle Stereo- und 
Mehrkanal-Clips:

 Klicken Sie bei gedrückter Wahl- (Mac) bzw. 
Alt-Taste (Windows) auf das Erweitern-/ 
Reduzieren-Dreieck.

Sie können einzelne Teile eines in erweiterter 
Darstellung dargestellten Stereo- oder Mehrkanal-
Clips unabhängig von anderen zugehörigen Clips 
in der Clipliste auswählen.

Regeln für Stereo- und 
Mehrkanal-Clips
Damit Stereo- und Mehrkanal-Audio-Clips als 
Sammelclips angezeigt werden, müssen die Teil-
Clips die gleiche Länge haben. Wurde ein bereits 
bestehender Stereo- oder Mehrkanal-Clip auf 
mehrere Monospuren gezogen und so editiert, dass 
mehrere einzelne Clips nicht mehr gleich lang sind, 
wird der Stereo-Clip ausgeblendet und die Clips 
werden in der Clipliste einzeln angezeigt.

Benennen und Anzeigen von 
Clips in der Clipliste
Eine normale Session kann aufgrund der vielen 
Dutzend Spuren und Hunderten von Clips recht 
unübersichtlich werden. Sie können eine Vielzahl von 
Maßnahmen ergreifen, um die Clips einer Session zu 
verwalten und den Überblick zu behalten:

• Umbenennen vorhandener Clips

• Festlegen, wie automatisch erzeugte Clips 
umbenannt werden

• Ausblenden automatisch erzeugter Clips

• Entfernen nicht verwendeter Clips

Umbenennen von Clips
Im Verlauf einer Session können Sie Clips mit 
anschaulicheren Namen umbenennen oder 
vorhandene Namen abkürzen oder vereinfachen. 
Wenn Sie einen beim Editieren automatisch 
erzeugten Clip umbenennen, wird dieser zu einem 
benutzerdefinierten Clip, der auch dann noch in der 
Clipliste angezeigt wird, wenn automatisch erzeugte 
Clips ausgeblendet werden.

Verbleibt ein Clip in einer Spur, können Sie 
einfach eine Umbenennung vornehmen, indem Sie 
mit einem der Grabber-Tools darauf 
doppelklicken. Befindet sich der Clip jedoch nicht 
in einer Spur oder möchten Sie mehrere Clips 
umbenennen, ist es sinnvoller, den Rename-
Befehl aus der Clipliste zu verwenden.

Stereo-Clips in der erweiterten (oben) und der 
reduzierten Darstellung (unten)
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Sie können einen Clip in einer Spur auch mit dem 
Rename-Befehl aus dem Cliplisten-Menü oder 
dem Kontextmenü umbenennen.

So benennen Sie einen oder mehrere Clips der 
Clipliste um:

1 Wenn Sie einen automatisch erzeugten Clip 
umbenennen möchten, wählen Sie in der 
Clipliste Show > Auto-Created.

2 Wählen Sie einen oder mehrere umzubenennende 
Clips in der Clipliste aus.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie im Cliplisten-Menü Rename.

• Klicken Sie mit der rechten Maustaste auf einen 
ausgewählten Clip und wählen Sie im Popup-
Menü die Rename-Option.

4 Geben Sie im Name-Dialogfeld einen neuen 
Namen für den Clip ein. Wenn ein Clip 
ausgewählt ist, der eine gesamte Audiodatei 
umfasst, geben Sie an, ob nur der Clip oder der 
Clip und die Datei umbenannt werden sollen.

5 Klicken Sie auf OK, um den Clip umzubenennen. 
Wenn Sie mehrere Clips umbenennen, werden 
Sie nacheinander aufgefordert, jeden Clip 
einzeln umzubenennen.

Optionen zur automatischen 
Benennung
Sie können die Optionen zur automatischen 
Benennung für einen Clip festlegen, wenn im Laufe 
des Editierens neue Clips daraus erzeugt werden. 

Die automatische Benennung von Clips wirkt sich 
nicht auf die Namen von übergeordneten 
Audiodateien aus. Stattdessen werden Verweise 
auf Clips innerhalb der übergeordneten Quelldatei 
gespeichert.

So stellen Sie die Optionen zum automatischen 
Benennen eines Clips ein:

1 Wählen Sie einen Clip in der Clipliste aus:

2 Wählen Sie im Cliplisten-Menü den Auto 

Rename-Befehl.

3 Geben Sie im Rename Selected Clips-
Dialogfeld den Text ein, der als Name 
verwendet werden soll, wenn aus diesem Clip 
automatisch weitere Clips erzeugt werden.

Name – legt den Stammnamen für die automatisch 
erzeugten Clips fest.

Starting Number – legt die Startnummer für 
fortlaufend nummerierte neue Clips fest.

Number of Places – legt die Anzahl der Ziffern 
fest, die der automatisch fortlaufenden 
Nummerierung vorangestellt werden sollen.

Suffix – legt einen Text fest, der dem Namen nach 
der automatisch fortlaufenden Nummerierung 
angehängt werden soll.

4 Klicken Sie auf OK.

Ist in den Bearbeitungseinstellungen die Clip 
List Selection Follows Edit Selection-Option 
aktiviert, können Sie einen Clip in der 
Clipliste markieren, indem Sie ihn in einer 
Spur auswählen.

Name-Dialogfeld

Rename Selected Clips-Dialogfeld
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Verwalten von Clips in 
der Clipliste
Während des Editierens einer Session kann die 
Clipliste schnell sehr umfangreich und mit neuen 
Clips gefüllt werden, die entweder absichtlich erstellt 
wurden oder aber automatisch durch Schneiden, 
Einfügen und Trennen oder den Import von 
Clipgruppen-Dateien (oder REX-Dateien als 
Clipgruppen) erzeugt wurden. Pro Tools bietet Ihnen 
die Möglichkeit, Clips aus Ihrer Session zu entfernen 
oder auszublenden und somit zu vermeiden, dass Sie 
durch eine unnötig lange Clipliste scrollen müssen.

Ausblenden automatisch 
erzeugter Clips
Sie können Clips ausblenden, die beim Editieren 
automatisch erzeugt wurden.

So blenden Sie automatisch erzeugte Clips aus:

 Heben Sie im Cliplisten-Menü die Auswahl 
von Show > Auto-Created auf. Wenn diese 
Option deaktiviert ist, werden nur die 
benutzerdefinierten Clips in der 
Clipliste angezeigt.

Zu den benutzerdefinierten Clips zählen:

• Whole-file Clips

• Bei der Aufnahme erzeugte Clips

• Importierte Clips

• Umbenannte Clips

• Durch die AudioSuite-Verarbeitung erzeugte Clips

• Neue Clips, die mit den Befehlen Clip > Capture 
oder Edit > Separate Clip erstellt wurden

• Clips, die durch das Trimmen von Whole-File-
Audio-Clips entstanden sind

Wenn automatisch erzeugte Clips ausgeblendet sind 
und eine bestimmte Anzahl überschritten haben, 
werden Sie von Pro Tools darauf hingewiesen. Sie 
haben dann die Möglichkeit, sie zu löschen. Wenn Sie 
die Clips löschen, werden sämtliche automatisch 
erzeugte Clips gleichzeitig gelöscht. 

Um sicherzugehen, dass bestimmte automatisch 
erzeugte Clips erhalten bleiben, müssen Sie sie 
umbenennen. Durch das Benennen eines Clips wird 
dieser von einem automatisch erzeugten Clip in einen 
benutzerdefinierten Clip umgewandelt 
(siehe „Umbenennen von Clips“ auf Seite 277).

Löschen unerwünschter Clips
Sie können in der Clipliste unerwünschte Clips 
auswählen und sie dann mit dem Clear-Befehl aus 
der Session entfernen. Clips, die eine gesamte 
Datei enthalten, können permanent von der 
Festplatte gelöscht werden.

So finden und entfernen Sie nicht genutzte Clips 
einer Session:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie für MIDI-Clips im Cliplisten-Menü 
Select > Unused.

• Wählen Sie für Audio-Clips aus dem Cliplisten-
Menü Select und dann je nach Bedarf Unused, 
Unused Except Whole Files oder Offline.

2 Wenn sämtliche ungenutzte Clips ausgewählt sind, 
wählen Sie im Cliplisten-Menü den Clear-Befehl. 
Das Clear Selected-Dialogfeld wird geöffnet.

Der Clear-Befehl lässt sich nicht rückgängig 
machen.
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3 Wählen Sie im Clear Selected-Dialogfeld die 
Option Automatically select all unused clips, 
wenn Sie sichergehen möchten, dass alle nicht 
verwendeten Clips einschließlich Whole-File-
Clips zum Löschen oder Entfernen ausgewählt 
werden. Jegliche zuvor in der Clipliste 
getroffene Auswahl wird ignoriert.

4 Sie haben folgende Möglichkeiten:

• Klicken Sie auf Remove, um die ungenutzten 
Clips aus der Session zu entfernen.

• Wenn Sie einen Whole-File-Audio-Clip löschen 
und diese Audiodatei auch dauerhaft von Ihrer 
Festplatte entfernen möchten, klicken Sie 
auf Delete.

Wenn Sie Audiodateien für mehrere Clips löschen, 
blendet Pro Tools bei jeder Audiodatei ein 
Warndialogfeld ein. 

So umgehen Sie wiederholte Warndialogfelder:

 Klicken Sie bei gedrückter Wahltaste (Mac) bzw. 
Alt-Taste (Windows) auf die Delete-Schaltfläche 
des Clear-Dialogfelds. Dadurch werden sämtliche 
Audiodateien ohne weitere Warnmeldung 
nacheinander von Ihrer Festplatte gelöscht (für 
jeden nicht verwendeten Clip). 

Befehle des Clipnamen-
Kontextmenüs
Wenn Sie mit der rechten Maustaste in der Clipliste 
auf einen Clipnamen klicken, wird ein Kontextmenü 
mit den folgenden Befehlen geöffnet:

Clear – entfernt ausgewählte Clips aus der Session.

Rename – benennt ausgewählte Clips um

Time Stamp – ändert den Zeitstempel für 
ausgewählte Clips.

Replace Clip (nur Pro Tools HD) – ersetzt mehrere 
Instanzen eines Clips durch die eines anderen Clips.

Compact – komprimiert ausgewählte Clips.

Export Clip Definitions – exportiert Definitionen 
ausgewählter Clips.

Export Clips as Files – exportiert ausgewählte 
Clips als Dateien.

Recalculate Waveform Overviews – zeichnet 
Wellenformen für ausgewählte Clips neu.

Select Parent in Workspace – hebt die 
übergeordnete Datei des ausgewählten Clips im 
Workspace-Browser hervor.

Reveal in Finder/Reveal in Explorer  – zum 
Anzeigen der übergeordneten Datei eines einzelnen 
Clips im Mac Finder oder Windows Explorer

Object Select in Edit Window – wählt den Clip als 
Objekt im Edit-Fenster aus.

Verwenden Sie diesen „Power-Löschmodus“ 
mit Bedacht. Das Löschen der Dateien kann 
nicht mehr rückgängig gemacht werden.
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Kapitel 16: Workspace-Browser

Der Pro Tools Workspace bietet eine intuitive, 
Browser-ähnliche Benutzeroberfläche mit einer 
integrierten Datenbank, die besonders für die 
Verwaltung von Metadaten und Medien geeignet ist.

Workspace-Browser bieten umfangreiche 
Datenbank-Tools, mit denen Sie Audio-, MIDI- und 
Videodateien, Plug-In-Einstellungen (.txf), Guitar 
Rig-Einstellungen (nur Eleven Rack) sowie Session-
Dateien durchsuchen, sortieren, abhören und 
importieren können. Sie können mehrere Browser 
mit verschiedenen Anordnungs- und 
Anzeigeeinstellungen verwenden, um so Ihre 
Arbeitsumgebung anzupassen. 

Workspace-Browser
Workspace-Browser bieten eine intuitive 
Benutzeroberfläche für Datenbanken mit einer 
Vielzahl von benutzerfreundlichen Optionen für 
spezifische Dateiverwaltungsaufgaben (wie etwa 
Such- und Sortierfunktionen).

Workspace-Browser in Pro Tools entsprechen den 
Fenstern des Betriebssystems auf Ihrem 
Computer, sind jedoch speziell für den 
Arbeitsablauf mit Pro Tools konzipiert. Mehrere 
Browser können gleichzeitig angezeigt werden, 
wobei ihre Anzeigeeinstellungen unabhängig 
voneinander festgelegt werden können.

In einem Workspace-Browser können Sie 
Audiodateien, Videodateien und Sessions suchen 
und sortieren. Im Browser angezeigte Audio-, 
Video- und Session-Dateien können direkt in die 
aktuelle Pro Tools-Session gezogen und dort 
abgelegt werden.

Wenn Offline-Elemente benötigt werden, können Sie 
die entsprechenden Dateien mit Pro Tools suchen und 
erneut mit den Online-Medien koppeln. 

Über den Arbeitsbereich-Browser können Sie auf 
alle bereitgestellten Volumes und alle darauf 
enthaltenen Ordner und Dateien zugreifen. 

Im Arbeitsbereich-Browser können Sie folgende 
Aktionen durchführen:

• Zugriff auf bereitgestellte Volumes

• Zugriff auf alle Kataloge

• Gleichzeitiges Durchsuchen mehrerer Volumes 
und Kataloge

• Bestimmen von Volumes zur Aufnahme und 
Wiedergabe, nur zur Wiedergabe oder zur 
Datenübertragung

• Anzeigen, Verwalten, Abhören und Importieren 
von Einzelelementen in Katalogen oder auf 
bereitgestellten Volumes

• Aktualisieren von Datenbanken für Volumes

Informationen zu Drag & Drop von Dateien 
aus Workspace-Browsern in Ihre Pro Tools-
Session finden Sie unter „Importieren von 
Dateien per Drag & Drop“ auf Seite 329.
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Volumes

Workspace-Browser ermöglichen die Dateiverwaltung 
auf lokalen Volumes und Netzwerk-Volumes. 
Bei Volumes handelt es sich um formatierte Partitionen 
auf einem Laufwerk (einer Festplatte). Alle im 
Workspace vorgenommenen Änderungen (wie 
Kopieren oder Verschieben von Dateien und Ordnern) 
werden auf den Volumes selbst widergespiegelt. 
Volumes können Folgendes sein: bereitgestellten 
Festplatten, Netzwerklaufwerke und Wechselmedien 
(wie CD-ROMs).

Wenn Volumes im Bereich „Websites“ angezeigt 
werden, können Sie folgende Aktionen durchführen:

• Anzeigen, Verwalten, Abhören und Importieren 
einzelner Elemente auf dem Volume

• Aktualisieren der Datenbank mit dem Inhalt des 
Volumes

Session

Workspace-Browser bieten umfassende Such- und 
Verwaltungsfunktionen für in der aktuellen 
Session referenzierte Dateien, unabhängig von 
ihrem Speicherort. 

Wenn die derzeit geöffnete Session im Bereich 
„Websites“ angezeigt wird, können Sie folgende 
Aktionen durchführen:

• Anzeigen der Mediendateien, die der aktuellen 
Session zugeordnet sind (einschließlich aller 
fehlenden Dateien)

• Anzeigen, Verwalten, Abhören und Positionieren 
von Einzelelementen (im Spot-Modus)

Kataloge 

Kataloge stellen die höchste Ebene der Pro Tools-
Dateiverwaltung dar. Über die Kataloge können 
häufig verwendete Dateien aus verschiedenen 
Quellen in Bibliotheken zusammengefasst werden. 
Kataloge können sortiert und durchsucht werden, 
auch wenn die referenzierten Dateien offline sind. 

Kataloge bieten die folgenden Funktionen:

• Zusammenstellen und Gruppieren von Dateien 
auf beliebigen Volumes

• Erstellen von Katalogen für komplette Volumes 
zum Anzeigen und Durchsuchen des Volume, auch 
wenn dieses offline ist

• Anzeigen, Verwalten, Abhören und Importieren 
von Einzelelementen in den Katalog

• Aktualisieren der Datenbank mit dem Inhalt des 
Volume

Task Manager-Fenster
Das Task Manager-Fenster dient zum Anzeigen 
und Verwalten aller Hintergrundvorgänge, die mit 
Pro Tools gestartet werden können. Über das Task 
Manager-Fenster können Sie 
Hintergrundfunktionen wie beispielsweise das 
Kopieren von Dateien, das Ausführen von 
Suchfunktionen und das Erstellen eines Indexes 
überwachen, unterbrechen oder abbrechen.

Relink-Fenster
Mit den Funktionen im Relink-Fenster können 
Sessions und Kataloge mit Mediendateien erneut 
gekoppelt werden. Das Suchen und Einlesen 
fehlender Dateien zur Verwendung in der 
aktuellen Session erfolgt mittels Relink-Tools. 

Weitere Informationen finden Sie unter 
„Kataloge“ auf Seite 318.

Weitere Informationen finden Sie unter 
„Task Manager-Fenster“ auf Seite 321.

Weitere Informationen finden Sie unter 
„Relink-Fenster“ auf Seite 314.
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Performance- und 
Transfer-Volumes
Mit Workspace-Browsern können Sie Sessions 
und Medien sowohl von Performance- als auch 
von Transfer-Volumes anzeigen, verwalten 
und importieren.

PerformanceVolumes – dies sind Volumes 
(Festplatten), die für die Wiedergabe geeignet sind 
und im Arbeitsbereich-Browser für die Aufnahme 
und Wiedergabe („R“) oder nur für die 
Wiedergabe („P“) von Mediendateien in einer 
Pro Tools-Session gekennzeichnet wurden.

Transfer-Volumes – dies sind Volumes, die nicht für 
die Wiedergabe von Medien in Pro Tools geeignet 
sind (wie beispielsweise gemeinsam genutzte 
Netzlaufwerke oder CD-ROMs) oder Speicher-
Volumes (Festplatten), die im Arbeitsbereich-Browser 
mit „T“ (Transfer) gekennzeichnet sind. Transfer-
Volumes können nicht zur Wiedergabe und 
Aufnahme von Medien in einer Pro Tools-Session 
verwendet werden. Mit „T“ (Transfer) 
gekennzeichnete Volumes sind für die Übertragung 
von Session- und Mediendateien zwischen 
verschiedenen Pro Tools-Systemen geeignet.

Datenbanken
Die in Workspace-Browsern angezeigten 
Informationen werden in systemweiten Pro Tools-
Datenbanken gespeichert. In Pro Tools erstellt eine 
zentrale Datenbank für alle bereitgestellten Volumes 
(einschließlich Transfer-Volumes) automatisch. 
Pro Tools verwendet eine einzelne Datenbankdatei, 
die einen Index aller Volumes (Festplatten, 
Netzlaufwerke und Wechselmedien) und Kataloge 
enthält. 

Auf dem Mac ist die Datenbankdatei in 
/Users/Shared/Pro Tools gesichert.

Unter Windows ist die Datenbankdatei 
in <Systemdrive>/Users/Public/Pro 
Tools gespeichert.

Der Wellenform-Cache für Audiodateien, die von 
der Datenbank indiziert werden, ist in der 
Datenbankdatei gespeichert. Dazu gehören auch 
die kleinen Wellenform-Bilder für das Vorhören 
(Wellenform-Cache-Dateien für Sessions werden 
weiterhin im Session-Ordner gespeichert).

Es gibt auch eine globale Wellenform-Cache-Datei 
für die Speicherung von Audiodatei-Metadaten, 
wenn keine Session geöffnet ist, oder für Dateien, die 
sich auf schreibgeschützten Volumes befinden. Wie 
in früheren Versionen von Pro Tools ist dies eine 
separate Datei, die unabhängig von der 
Datenbankdatei gespeichert wird.

Pro Tools-Datenbanken verwenden zwei Dateitypen:

Workspace.wksp – speichert Metadaten für 
Medien- und Session-Dateien eines bestimmten 
Volume oder Katalogs.

Wavecache.wfm – speichert Wellenform-
Übersichten für alle in einer Session referenzierten 
Audiodateien.

Weitere Informationen finden Sie unter 
„Volume-Berechtigungen“ auf Seite 286.

In Pro Tools 11 gehört die Datenbankdatei zur 
Version und ist nicht mit früheren Versionen von 
Pro Tools kompatibel. Wenn Sie ein System 
verwenden, auf dem Pro Tools 11 und 
Pro Tools 10 parallel installiert sind, gibt es 
separate Datenbankdateien für jede Version von 
Pro Tools. Datenbankdateien der gleichen 
Version sind aber plattformübergreifend 
kompatibel (Mac und Windows).

Beim Löschen der Database-Datei gehen alle 
Datenbankinformationen verloren. Zum 
Wiederherstellen einer gelöschten Database 
müssen Ihre Volumes neu indiziert werden 
(siehe „Indizieren von Workspace-
Datenbanken“ auf Seite 288).
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Workspace-Browserlayout und -Tools
Die Workspace-Browser zeigen alle Dateien der Datenbank an, nicht nur Pro Tools-Dateien. Es können 
auch unbekannte Dateitypen sowie Aliase und Desktop-Ordner angezeigt werden. 

Zur Maximierung der Verarbeitungsgeschwindigkeit 
und zum Schutz wichtiger Komponenten zeigen 
Workspace-Browser nicht alle Ordner an. Workspace-
Browser unter Windows zeigen beispielsweise die 
Ordner „WU Temp“ bzw. Ordner mit 
Systemlaufwerksinformationen nicht an. Workspace-
Browser auf einem Mac zeigen den Ordner „System“ 
nicht an. Deshalb werden diese Ordner auch nicht 
durch Workspace-Vorgänge indiziert, durchsucht, 
sortiert oder sonstwie geändert. Sie sollten niemals 
Session- oder Mediendateien von Pro Tools in diesen 
Ordnern speichern.

Im Folgenden werden die wichtigsten Elemente 
eines Workspace-Browsers erläutert. 

Symbolleiste – enthält das Browser-Menü, 
das Suchsymbol, die Schaltflächen für die 
Anzeigevoreinstellungen (1 bis 5), die Workspace-
Browser-Navigationshilfen und die Preview-Tools. 

Elementliste – zeigt den Inhalt eines Volume, eines 
Ordners, einer Session oder einer Katalogdatenbank in 
Zeilen an. 

Grundlegende Tools, Fensterbereiche und Spalten des Workspace-Browsers

Symbolleiste

Elementliste

Locations-Bereich Browser-Bereich

Spaltenkopf

Spalten Anzeigevoreinstellungen Browser-MenüAbhör-Steuerelemente

Schaltfläche „Übergeordneter Ordner“

Suchfunktionen

Show/Hide

Trennung

Titelleiste
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Spalten – geben die Art der in der Elementliste 
angezeigten Metadaten (wie Dateiname und -format) 
für Volumes, Ordner und Dateien in der Elementliste 
an. Durch Ziehen der Spaltenränder bzw. -kopfzeilen 
können Position bzw. Breite der Spalten geändert 
werden.

In Workspace-Browsern entspricht jede Datenzeile 
einem Element (etwa Datei oder Ordner). Die Daten 
zu jedem Element werden in Spalten angezeigt. 

Locations-Bereich – verwenden Sie diesen Bereich, 
um zu den Volumes (lokale und Netzlaufwerke) auf 
Ihrem System, der derzeit geöffneten Session, 
indizierten Medienkatalogen und dem 
Systemanwenderverzeichnis zu navigieren.

Browser-Bereich – zeigt die Inhalte der im 
Locations-Bereich ausgewählten Elemente oder 
Suchergebnisse an.

Öffnen von Workspace-Browsern
Es gibt verschiedene Möglichkeiten zum Öffnen, 
Schließen und Navigieren in Workspace-Browsern.

Wenn noch kein Workspace-Browser geöffnet ist, 
haben Sie zum Öffnen folgende Möglichkeiten:

 Wählen Sie „Window > Workspace“.

 Drücken Sie Wahl +; (Mac) bzw. Alt +; 
(Windows), um den Workspace-Browser zu 
öffnen und zu schließen. Wenn mehrere 
Workspace-Browser geöffnet sind, können Sie 
sie mit diesen Tastaturbefehlen durchblättern 
und einen Workspace-Browser nach dem 
anderen im Vordergrund anzeigen. 

So öffnen Sie einen neuen Workspace-Browser 
für Volumes:

 Drücken Sie Wahl + I (Mac) bzw. Alt + I 
(Windows). 

So öffnen Sie einen neuen Workspace-Browser für 
ein Projekt:

 Drücken Sie Wahl + O (Mac) bzw. Alt + O 
(Windows). 

Führen Sie einen der folgenden Schritte aus, 
um einen neuen Workspace-Browser für ein 
ausgewähltes Volume bzw. einen ausgewählten 
Katalog oder Ordner zu öffnen:

 Doppelklicken Sie bei gedrückter Befehlstaste 
(Mac) bzw. Strg-Taste auf ein Volume, einen 
Katalog oder Ordner im geöffneten Workspace-
Browser.

 Drücken Sie die Wahltaste + die Pfeiltaste nach 
unten (Mac) bzw. die Alttaste + die Pfeiltaste 
nach unten (Windows), um das ausgewählte 
Volume bzw. den ausgewählten Katalog oder 
Ordner in einem neuen Workspace-Browser zu 
öffnen.

Anzeigen des Inhalts eines 
Volume, Ordners oder Katalogs

Führen Sie einen der folgenden Schritte aus, 
um den aktuell ausgewählten Ordner zu erweitern 
oder zu reduzieren:

 Klicken Sie im Browser-Bereich oder im 
Locations-Bereich neben dem Volume, Ordner, 
Session oder Katalog auf das Symbol zum 
Erweitern bzw. Reduzieren.

 Wählen Sie ein Volume, einen Ordner oder 
Katalog und drücken Sie die Nach-rechts-
Pfeiltaste zum Erweitern oder die Nach-links-
Pfeiltaste zum Reduzieren.

Diese Tastaturbefehle schließen den 
Workspace-Browser auch, wenn sich die 
Auswahl im Locations-Bereich im Volumes-
Stammordner befindet. Wenn im Locations-
Bereich ein anderes Element ausgewählt ist, 
kann über diese Tastaturbefehle ein neuer 
Browser für dieses Element geöffnet werden.
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So wechseln Sie in einem Browser eine Ebene 
nach oben: 

 Klicken Sie in der Symbolleiste auf den 
Zurück-Pfeil des Browsers. 

Verschieben von Workspace-
Browsern in den Vorder- oder 
Hintergrund

So verschieben Sie alle geöffneten Workspace-
Browser in den Vordergrund:

 Wählen Sie Window > Browsers > Bring to 

Front. 

So verschieben Sie alle geöffneten Workspace-
Browser in den Hintergrund:

 Wählen Sie Window > Browsers > Send to 

Back. 

Alle geöffneten Workspace-Browser werden in den 
Hintergrund und die anderen Fenster in den 
Vordergrund verschoben: Die Workspace-Browser 
bleiben dennoch weiterhin geöffnet und zugänglich. 

So verschieben Sie einen geöffneten Workspace-
Browser in den Vordergrund:

 Klicken Sie auf Window > Browsers und wählen 
Sie aus dem Untermenü einen geöffneten 
Workspace-Browser.

So gehen Sie zum vorherigen/nächsten 
Workspace-Browser:

 Drücken Sie Strg + Pfeil nach links/rechts 
(Windows) bzw. Befehl + Pfeil nach 
links/rechts (Mac).

Schließen von Workspace-
Browsern
So schließen Sie alle Workspace-Browser:

 Klicken Sie bei gedrückter Wahltaste (Mac) 
bzw. Alt-Taste (Windows) auf das Schließfeld 
eines Workspace-Browsers. 

Volume-Berechtigungen
Workspace enthält eine Berechtigungenspalte 
(Perm.) für Volume-Berechtigungen. In dieser 
Spalte können Sie festlegen, ob ein Volume die 
Berechtigungen zur Aufnahme, Wiedergabe oder 
zur Übertragung von Mediendateien besitzt.

R (Record – Aufnahme und Wiedergabe) – das 
Volume ist zur Wiedergabe von Audio- und 
Videodateien sowie zur Aufnahme neuer 
Audiodateien geeignet. 

P (Playback – nur Wiedergabe) – das Volume ist 
zur Wiedergabe von Audio- und Videodateien 
geeignet, kann jedoch nicht zur Aufnahme von 
Dateien verwendet werden. 

T (Transfer – Übertragung) – das Volume ist zum 
Speichern, Übertragen oder Abhören von Dateien 
geeignet, kann aber nicht zur Aufnahme oder 
Wiedergabe verwendet werden. 

Um in einem Browser eine Ebene nach oben 
zu wechseln, drücken Sie Befehl + Pfeil nach 
oben (Mac) bzw. Strg + Pfeil nach oben 
(Windows).

Um alle Workspace-Browser in den 
Vordergrund zu verschieben, drücken Sie 
Wahl + J (Mac) bzw. Alt + J (Windows).

Um alle Workspace-Browser in den 
Hintergrund zu verschieben, drücken Sie 
Wahl + Umschalt + J (Mac) bzw. Alt + 
Umschalt + J (Windows).

Da das Tasks-Fenster ein Dienstprogramm 
und kein Browser ist, bleibt es geöffnet.

Wenn Sie ein Pro Tools-System mit mehreren 
Laufwerken haben und die gleichzeitige 
Aufnahme von mehreren Spuren planen, 
sollten Sie das Systemlaufwerk als nur für die 
Wiedergabe oder nur für den Transfer 
kennzeichnen.
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So ändern Sie die Kennzeichnung eines Volume:

1 Öffnen Sie einen Workspace-Browser.

2 Wählen Sie im Locations-Bereich die Volumes-
Option.

3 Klicken Sie auf den Browser-Bereich und wählen 
Sie die für das Volume geeigneten Berechtigungen.

Aufheben der Bereitstellung 
von Volumes
Verwenden Sie den Finder (Mac) oder Windows 
Explorer (Windows), um Volumes bereitzustellen 
und die Bereitstellung aufzuheben, während 
Pro Tools ausgeführt wird. 

Arbeiten mit Elementen in 
Workspace-Browsern

Öffnen von Sessions
So öffnen Sie eine im Workspace-Browser 
aufgeführte Pro Tools-Session:

 Wenn derzeit keine Pro Tools-Session geöffnet 
ist, doppelklicken Sie im Browser-Bereich 
eines beliebigen Workspace-Browsers auf eine 
Pro Tools-Session-Datei. 

Öffnen von AAF- und OMF-
Sequenzen
AAF- und OMF-Sequenzen können in 
Workspace-Browsern geöffnet werden.

Sie können AAF- und OMF-Sequenzen auch per 
Drag & Drop aus Workspace-Browsern in die 
aktuelle Session bewegen.

So öffnen Sie eine AAF- oder OMF-Sequenz in 
einem Workspace-Browser:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie auf die AAF- oder OMF-
Sequenz im Browser-Bereich eines beliebigen 
Workspace-Browsers; dabei soll keine 
Pro Tools-Session geöffnet sein.

• Ziehen Sie die AAF- oder OMF-Sequenz vom 
Browser-Bereich eines Workspace-Browsers in 
die Timeline einer geöffneten Session.

2 Nehmen Sie im Import Session Data-Dialogfeld 
die erforderlichen Einstellungen vor.

3 Klicken Sie auf OK.

Erstellen und Öffnen von 
Ordnern in Workspace-
Browsern
In Workspace-Browsern können Sie Ordner 
(Unterverzeichnisse von Dateisystemen) erstellen 
und bearbeiten. Bei allen Ordnern können Sie die 
Anzeige mithilfe der entsprechenden Symbole 
erweitern oder reduzieren. Das Ziehen von 
Elementen auf ein Ordnersymbol entspricht dem 
Ziehen in einen geöffneten Workspace-Browser. 

So erstellen Sie einen neuen Ordner im Volume, 
Ordner oder Katalog:

1 Wählen Sie Volume, Ordner oder Katalog, in dem 
Sie einen neuen Ordner erstellen möchten.

2 Wählen Sie im Browser-Menü New Folder. 

3 Geben Sie einen Namen für den Ordner ein und 
klicken Sie auf OK. 

4 In den Volumes und Ordnern werden die Ordner 
auf der Festplatte erstellt. In den Katalogen 
werden die Ordner nur in der Katalogdatenbank 
erstellt. Nach dem Hinzufügen neuer Elemente 
wird die Elementliste aktualisiert. 

Kennzeichnen eines Volume im Arbeitsbereich
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So öffnen Sie einen Ordner im aktuellen 
Workspace-Browser:

 Doppelklicken Sie auf den Ordner oder klicken 
Sie auf das Symbol zum Erweitern bzw. 
Reduzieren für das Element. 

So öffnen Sie einen Ordner in einem eigenen, 
neuen Workspace-Browser:

 Doppelklicken Sie bei gedrückter Befehlstaste 
(Mac) bzw. Strg-Taste (Windows) auf den 
Ordner. Das vorherige (übergeordnete) 
Workspace-Browser-Fenster bleibt geöffnet. 

Scrollen und Verschieben einer 
Auswahl
So scrollen Sie im aktiven Fensterbereich nach 
oben oder unten:

 Drücken Sie die Bild-auf- oder Bild-ab-Taste.

So scrollen Sie an den Anfang oder das Ende des 
aktiven Fensterbereichs:

 Drücken Sie die Pos1-Taste (für den Anfang) 
oder die Ende-Taste (für das Ende).

So verschieben Sie Elemente im aktuellen 
Workspace-Browser nach oben oder nach unten:

1 Wählen Sie Elemente in einem Workspace-
Browser aus und vergewissern Sie sich, dass 
sich das Fenster im Vordergrund befindet. 

2 Drücken Sie die Nach-oben- oder Nach-unten-
Pfeiltaste.

Eingeben von Text in 
Workspace-Browsern
In vielen Textfeldern können Sie die Daten eines 
Elements ersetzen oder aktualisieren. 

So bearbeiten und schließen Sie ein Textfeld und 
kehren zum vorherigen Anzeigestatus zurück:

 Drücken Sie die Eingabetaste.

So kehren Sie zum vorherigen Text zurück und 
brechen eine Textbearbeitung ab:

 Drücken Sie die Esc-Taste.

Indizieren von Workspace-
Datenbanken
Der Indizierungsvorgang beinhaltet das Lesen von 
Mediendateien, das Extrahieren der erforderlichen 
Metadaten für jede Datei und das Speichern dieser 
Daten in einer zugehörigen Datenbank. Dadurch 
können die Daten in den Spalten eines Workspace-
Browsers angezeigt werden. Vollständig indizierte 
Volumes oder Ordner können sehr schnell 
durchsucht werden, da alle Metadaten bereits sortiert 
und geordnet wurden.

Nicht indizierte Volumes oder Ordner werden beim 
nächsten Öffnen in einem Workspace-Browser 
automatisch indiziert. Dieser Vorgang kann bei 
Volumes und Ordnern mit zahlreichen 
Mediendateien einige Zeit in Anspruch nehmen. 
Daher sollten Sie bestimmte Volumes oder Dateien 
vor dem Start eines Projekts manuell indizieren, um 
den Arbeitsablauf zu beschleunigen.

Verschieben Sie den Browser in den 
Vordergrund, wählen Sie den Ordner und 
drücken Sie Befehl + Pfeil nach unten 
(Mac) bzw. Strg + Pfeil nach unten 
(Windows), um einen Ordner in diesem 
Workspace-Browser zu öffnen.

Verschieben Sie den Browser in den 
Vordergrund, wählen Sie den Ordner und 
drücken Sie Befehl + Option + Pfeil nach 
unten (Mac) bzw. Strg + Umschalt + Pfeil 
nach unten (Windows), um einen Ordner im 
eigenen neuen Browser zu öffnen.

Weitere Informationen zum Bearbeiten von 
Spalten finden Sie unter „Spaltendaten“ auf 
Seite 294.
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Indizieren während eines 
Suchvorgangs
Wenn Sie das erste Mal ein noch nicht indiziertes 
Volume oder einen Ordner im Browser öffnen, 
beginnt Pro Tools automatisch, die Datenbank mit 
den Inhalten der entsprechenden Ebene zu füllen. In 
der Elementliste des Browsers werden Dateien und 
Ordner angezeigt; die Metadaten zu jedem Element 
erscheinen in den entsprechenden Spalten. Das 
Indizieren wird so lange fortgesetzt, bis Sie den 
Browser schließen oder der Ordner vollständig 
indiziert ist.

Beim nächsten Öffnen des Browsers werden die 
bereits indizierten Metadaten der Elemente sofort 
angezeigt. Wenn der Browser oder Ordner vor 
Abschluss des Indizierungsvorgangs geschlossen 
oder der Inhalt des Ordners seit dem letzten 
Durchsuchen geändert wurde, aktualisiert Pro Tools 
die Datenbank beim nächsten Öffnen automatisch. 
Dies bedeutet, dass die Datenbank ist immer auf dem 
neuesten Stand für den gerade durchsuchten Ordner 
ist. (Die derzeitige Aktivität wird im Task Manager 
angezeigt.)

Das Indizieren während des Durchsuchens spart Zeit, 
da die Datenbank nur mit Elementen gefüllt wird, die 
sich auf der Ebene des aktuellen Volume befinden. 
Wenn Sie also das Stammverzeichnis des Volume 
durchsuchen, werden nur die Ordner und Dateien im 
Stammverzeichnis indiziert. Beim Öffnen eines 
Ordners indiziert Pro Tools nur die darin enthaltenen 
Elemente. Folglich sind innerhalb einer Datenbank 
immer nur die Teile indiziert, die Sie bereits 
durchsucht haben. Suchvorgänge können bei 
vollständig indizierten Volumes jedoch schneller und 
genauer ausgeführt werden. 

Manuelles Indizieren
Durch manuelles Indizieren werden alle fehlenden 
Daten ergänzt; außerdem werden geänderte Daten 
für ausgewählte Ordner und die zugehörigen 
Unterordner aktualisiert. 

So aktualisieren Sie den Index eines Ordners und 
den dazugehörigen Unterordner:

1 Wählen Sie das Element in einer Elementliste 
des Workspace-Browsers. 

2 Wählen Sie aus dem Browser-Menü Update 

Index for Selected Items. 

So aktualisieren Sie den Index eines gesamten 
Volume:

1 Wählen Sie im Arbeitsbereich-Browser das 
entsprechende Volume. 

2 Wählen Sie aus dem Browser-Menü Update 

Index for Selected Items. 

Anzeigen des Datums der letzten Indizierung

In der Date Indexed-Spalte wird das Datum 
angezeigt, an dem der Index des Ordners und der 
zugehörigen Unterordner zuletzt aktualisiert 
wurden. Es kann jedoch sein, dass einzelne 
Unterordner zwischendurch erneut aktualisiert 
wurden.

Automatisches Aktualisieren von Aktionen 
in Pro Tools

Sobald eine Datei auf einem Volume oder in einer 
Session hinzugefügt, gelöscht oder geändert 
wurde, wird die Datenbank mit dieser Änderung 
sofort aktualisiert. 

Mit Windows Explorer oder Mac Finder 
durchgeführte Änderungen (etwa Kopieren oder 
Verschieben von Dateien) werden nicht von 
Pro Tools registriert und nur dann indiziert, wenn 
der entsprechende Ordner durchsucht oder eine 
manuelle Indizierung ausgeführt wird.
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Workspace-Browser-Menü 
In allen Workspace-Browsern befindet sich oben 
rechts in der Symbolleiste ein Browser-Menü. 
Workspace-Browser-Menüs enthalten wie 
nachstehend beschrieben spezifische Befehle für 
den im Locations-Bereich oder im Browser-
Bereich ausgewählten Elementtyp. 

Sie können auch mit der rechten Maustaste auf 
Elemente im Locations-Bereich und im Browser-
Bereich klicken, um auf entsprechende Browser-
Menübefehle zuzugreifen.

New Folder – erstellt auf dem aktuell 
ausgewählten Volume, Ordner oder im aktuell 
ausgewählten Katalog einen neuen Ordner. 
Bei Volumes und Ordnern wird ein neuer Ordner 
auf der Festplatte erstellt. Weitere Informationen 
finden Sie unter „Erstellen und Öffnen von 
Ordnern in Workspace-Browsern“ auf Seite 287.

Create Catalog from Selection – erstellt einen 
vollständig indizierten Katalog mit allen im 
Locations-Bereich oder Browser-Bereich 
ausgewählten Elementen.

Calculate Waveform – berechnet die 
Wellenformanzeige für ausgewählte Audiodateien 
oder alle Audiodateien der ausgewählten 
Volumes, Ordner oder Kataloge.

Update Index for Selected Items – aktualisiert 
den Index der derzeit ausgewählten Volumes oder 
Ordner.

Delete Index for Selected Items – löscht den 
Dateiindex für die Elemente im ausgewählten 
Volume oder für Ordner aus der Datenbank.

Delete Index for All Offline Volumes – löscht die 
Indexe für alle Offline-Volumes aus der Datenbank.

Calculate Elastic Analysis – berechnet Elastic 
Audio-Analysedaten für alle ausgewählten 
Audiodateien. Analysierte Dateien werden bei 
samplebasierten Dateien mit einer blauen Uhr und 
bei tickbasierten Dateien mit einem grünen 
Metronom gekennzeichnet. Analysierte Dateien, in 
denen ein Tempo erkannt wurde, werden ebenfalls 
als tickbasiert aktualisiert, ihre Dauer wird in 
Bars|Beats angezeigt, und ihr ursprüngliches Tempo 
wird in der Tempo-Spalte angezeigt. Den Status der 
Elastic Audio-Analyse können Sie im Tasks-Fenster 
nachverfolgen.

Clear Elastic Analysis – entfernt die Elastic 
Audio-Analysedaten für alle ausgewählten 
Audiodateien. Dateien, in denen die Elastic Audio-
Analysedaten entfernt wurden, kehren zur 
samplebasierten Zeitbasis zurück, ihre Dauer wird 
in Minuten und Sekunden angezeigt und es wird 
kein Tempo für sie angezeigt.

Load Guitar Rig Settings (nur Eleven Rack) – 
lädt die Guitar Rig-Einstellungen für die 
ausgewählten Audiodateien mit integrierten Guitar 
Rig-Einstellungen aus einem Eleven Rack.

Select Offline Files – wählt alle derzeitigen 
Offline-Dateien aus.

Select Online Files – wählt alle derzeitigen 
Online-Dateien aus. 

Workspace-Browser-Menüsymbol

Weitere Informationen finden Sie unter 
„Wellenformen“ auf Seite 303.

Weitere Informationen finden Sie unter „Elastic 
Audio-Dateien im Workspace“ auf Seite 304.
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Select Transfer Files – wählt alle als Transfer-
Dateien (Dateien auf Medien ohne 
Wiedergabeunterstützung) gekennzeichneten 
Dateien aus. 

Invert Selection – kehrt die derzeitige Auswahl um.

Reveal in Finder/Explorer – öffnet das 
entsprechende übergeordnete Fenster der derzeit 
ausgewählten Datei im Finder (Mac) bzw. im 
Explorer (Windows). 

Open in New Workspace – öffnet das ausgewählte 
Element in einem neuen Browser. Das ausgewählte 
Element wird im neuen Browser hervorgehoben.

Relink Offline – öffnet das Relink-Fenster für die 
in der aktuellen Session ausgewählten Elemente.

Relink Selected Items – öffnet das Relink-Fenster 
mit allen ausgewählten Dateien, die im aktuellen 
Browser angezeigt und als „Files to Match“ 
(übereinstimmende Dateien) ausgewählt sind. Dieser 
Befehl ist nur für Kataloge und Sessions verfügbar.

Kopieren und neu koppeln – kopiert die im 
Browser der aktuellen Session ausgewählten 
Elemente in einen bestimmten Speicherort und 
koppelt die Session mit den Kopien anstelle der 
Originaldateien. Dadurch können Sie sehr einfach 
Dateien von einem Transfer- zu einem Performance-
Volume verschieben. Mit diesem Befehl können Sie 
auch in ausgewählten Katalogen Elemente kopieren 
und den derzeitigen Katalog mit den Kopien erneut 
koppeln. 

Duplicate Selected Items – erstellt ein Duplikat der 
ausgewählten Elemente am selben Speicherort. 

Rename Selected Item – benennt das ausgewählte 
Element um. 

Lock Selected Items – sperrt alle ausgewählten 
Elemente. Alle bereits gesperrten Dateien bleiben 
gesperrt. Durch das Sperren eines Ordners werden 
alle darin enthaltenen Dateien und Unterordner 
gesperrt. 

Unlock Selected Items – hebt die Sperre aller 
ausgewählten Elemente auf. 

Move To Trash/Move To Recycle Bin – verschiebt 
im Browser-Bereich ausgewählte Elemente in den 
Papierkorb. Die Elemente verbleiben solange im 
Papierkorb, bis Sie diesen mit dem entsprechenden 
Befehl für Ihr Betriebssystem leeren. Dieser 
Befehl ist nur für Session- oder Katalog-Elemente 
verfügbar.

Auto-Preview – aktiviert oder deaktiviert das 
automatische Vorhören von Dateien. Wenn diese 
Option aktiviert ist, wird beim Auswählen einer 
Datei im Browser das Vorhören gestartet. 
Die Vorhören-Schaltfläche wird aktualisiert und 
zeigt an, dass Auto-Preview aktiviert ist.

Loop Preview – die ausgewählten Datei wird im 
Loop-Modus vorgehört. Wenn Sie mehrere Dateien 
ausgewählt haben, wird nur die erste ausgewählte 
Datei vorgehört. Wenn der Loop-Vorhörmodus 
aktiviert ist, wird auf der Vorhören-Schaltfläche das 
Symbol für den Loop-Vorhörmodus angezeigt.

Spacebar Toggles File Preview – aktiviert oder 
deaktiviert die Verwendung der Leertaste für das 
Starten und Anhalten des Vorhörens. Wenn diese 
Option deaktiviert ist, verwenden Sie die Vorhören-
Schaltfläche zum Starten und Anhalten des 
Vorhörens. In diesem Modus wird die Wiedergabe 
der Session über die Leertaste gestartet bzw. 
angehalten. Auf diese Weise können Sie die Session 
wiedergeben und bei aktivierter Audio Files 

Conform to Session Tempo-Option die ausgewählte 
Audiodatei in zeitlicher Übereinstimmung mit der 
Session vorhören.

Wenn ein Browser als oberstes Fenster 
angezeigt wird, kann das Vorhören durch 
Drücken von Strg + P (Windows) bzw. 
Befehl + P (Mac) gestartet und angehalten 
werden. Auch über die Esc-Taste kann das 
Vorhören angehalten werden.
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Audio Files Conform to Session Tempo – gleicht 
alle tickbasierten Audiodateien mit Elastic Audio-
Analyse, ebenso wie REX- und ACID-Dateien, 
an das Tempo der Session an. Auf diese Weise 
können Sie die Session wiedergeben und 
simultan die ausgewählten Dateien in zeitlicher 
Übereinstimmung vorhören. Diese Option ist nur 
verfügbar, wenn eine Session geöffnet ist. Weitere 
Informationen finden Sie unter „Angleichen an das 
Session-Tempo beim Vorhören“ auf Seite 309. 

Wenn die Audio Files Conform to Session Tempo-
Option aktiviert ist, analysiert Pro Tools nicht 
analysierte Dateien beim Vorhören oder beim 
Import. Audiodateien, die als tickbasiert analysiert 
wurden, können dann im Session-Tempo 
vorgehört und beim Import an das Session-Tempo 
angeglichen werden.

Wenn die Audio Files Conform to Session Tempo-
Option deaktiviert ist, werden alle tickbasierten 
Audiodateien mit Elastic Audio-Analyse sowie 
REX- und ACID-Dateien in ihrem ursprünglichen 
Tempo vorgehört. 

Show Offline Volumes Aktivieren (oder 
deaktivieren) Sie den Befehl Show Offline Volumes, 
um alle indizierten Volumes aus der Datenbank im 
Locations-Bereich anzuzeigen (oder auszublenden).

Zusätzliche Workspace-Befehle 
in Katalogen
In Katalogen stehen die folgenden zusätzlichen 
Befehle zum Verwalten von Anmerkungen in 
ausgewählten Elementen zur Verfügung. 

Copy Database Comments to Clip Names – 
kopiert die Datenbankanmerkungen eines 
Elements in den zugehörigen Clipnamen. 

Copy File Comments to Clip Names (nur Mac) – 
kopiert die Dateianmerkungen eines Elements in 
den zugehörigen Clipnamen. 

Fensterbereiche und Anzeige 
in Workspace-Browsern
In Workspace-Browsern wird eine Elementliste 
mit verschiedenen Spalten (etwa für Dateiname, 
Dateigröße, Erstellungsdatum und Samplerate) 
angezeigt. 

Ein-/Ausblenden des Locations-
Bereich
Der Locations-Bereich kann ausgeblendet werden.

So blenden Sie den Locations-Bereich ein oder aus:

 Klicken Sie unten rechts im linken 
Fensterbereich auf das Symbol zum Ein-/ 
Ausblenden. 

Verschieben von Spalten

So verschieben Sie Spalten:

 Ziehen Sie die Spalte an die neue Position in 
Workspace. 

Anpassen der Spaltenbreite

So ändern Sie die Spaltenbreite:

 Ziehen Sie die rechte Spaltengrenze auf eine 
neue Breite. 

Weitere Informationen finden Sie unter 
„Anmerkungsfelder“ auf Seite 296.

Symbol zum Ein-/Ausblenden des Locations-Bereichs



Kapitel 16: Workspace-Browser 293

Ein- und Ausblenden von Spalten
Sie können in den Workspace-Browsern einzelne 
Spalten Ihrem Arbeitsablauf gemäß ein- oder 
ausblenden. Die Standardspaltenanzeige umfasst 
die Elemente, die in den meisten Sessions 
verwendet werden.

So blenden Sie einzelne Spalten ein oder aus:

 Klicken Sie bei gedrückter Ctrl-Taste (Mac) bzw. 
Windows-Taste (Windows) oder mit der rechten 
Maustaste auf eine Spaltenbezeichnung und 
wählen Sie den Spaltennamen im eingeblendeten 
Popup-Menü aus bzw. deaktivieren Sie ihn. 

So blenden Sie alle Spalten ein oder aus:

 Klicken Sie bei gedrückter Ctrl-Taste (Mac) bzw. 
Windows-Taste (Windows) oder mit der rechten 
Maustaste auf eine Spaltenbezeichnung und 
wählen Sie im Popup-Menü ALL oder NONE aus. 
(Nur die Spalte „Name“ wird noch angezeigt, 
wenn Sie die NONE-Option wählen.)

So zeigen Sie den Standardsatz von Spalten an:

 Klicken Sie bei gedrückter Ctrl-Taste (Mac) bzw. 
Windows-Taste (Windows) oder mit der rechten 
Maustaste auf eine Spaltenbezeichnung und 
wählen Sie im Popup-Menü DEFAULT aus. 

Anzeigevoreinstellungen
In Pro Tools können Sie bis zu fünf verschiedene 
Anzeigevoreinstellungen für den Workspace-Browser 
und das Relink-Fenster speichern. Sie können eine 
Voreinstellung aufrufen, indem Sie auf die 
Schaltfläche für die Anzeigevoreinstellung klicken. 

So speichern Sie eine Anzeigevoreinstellung:

1 Öffnen Sie den Workspace-Browser oder das 
Relink-Fenster. 

2 Ordnen Sie die Spalten und Ansichten an. 

3 Klicken mit gedrückter Befehlstaste (Mac) oder 
Strg-Taste (Windows) auf eine der 
Voreinstellungsschaltflächen 1 - 5.

So rufen Sie eine gespeicherte Voreinstellung ab:

 Klicken Sie auf die entsprechende Schaltfläche 
für die Anzeigevoreinstellung.

Sortieren von Spalten
Die Spalten können in aufsteigender oder 
absteigender Reihenfolge und bis zu vier Stufen 
tief sortiert werden.

So sortieren Sie die Spalten:

 Klicken Sie auf den Spaltentitelkopf. 

So wechseln Sie zwischen auf- und absteigender 
Sortierreihenfolge:

 Klicken Sie erneut auf den Spaltentitelkopf.

So sortieren Sie mehrere Spalten:

 Halten Sie die Wahl- (Mac) bzw. Alt-Taste 
(Windows) bei aufeinander folgenden 
Spaltenüberschriften gedrückt.

Ein- und Ausblenden von Spalten

Browser-Schaltflächen für Anzeigevoreinstellungen
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Spaltendaten
In Workspace-Browsern entspricht jede 
Datenzeile einem Element der Datenbank 
(etwa Datei, Session oder Volume). Jede Spalte 
zeigt bestimmte Daten eines Elements an.

Name – zeigt den Namen der Datei, des Ordners, 
des Volume, des Katalogs oder der Session an. Bei 
Offlineelementen sind die Namen kursiv dargestellt.

Perm. – zeigt nur die zugewiesenen Berechtigungen 
für Volumes für Medienaufnahme, -wiedergabe oder 
-übertragung an.

Kind – zeigt die Art des Volume an: Ordner, 
Katalog oder Datei. Bei Dateien wird in dieser 
Spalte die Art der Datei angezeigt: Session-Datei, 
Audiodatei, Videodatei usw. Dieses Feld kann 
nicht bearbeitet werden. Bei Audiodateien wird in 
der Spalte außerdem angezeigt, ob die Datei 
sample- oder tickbasiert ist.

Size – zeigt die Größe einer Datei an. Dieses Feld 
kann nicht bearbeitet werden.

Waveform – stellt die Audiodatei grafisch dar. 
Weitere Hinweise finden Sie unter 
„Wellenformen“ auf Seite 303.

Dauer – zeigt die Dauer einer Datei als absolute 
Zeitangabe (Minuten und Sekunden) unabhängig 
vom Timecodeformat an. Für Clipgruppen, MIDI-
Dateien, tickbasierte Elastic Audio-Dateien, REX- 
und ACID-Dateien wird die Dauer in Takten und 
Schlägen angezeigt. Dieses Feld kann nicht 
bearbeitet werden.

Date Indexed – gibt das Datum der letzten 
Indizierung des Elements an. Dieses Feld kann 
nicht bearbeitet werden.

Capacity – zeigt die Gesamtkapazität eines Volume 
an. Dieses Feld kann nicht bearbeitet werden. 

Free – zeigt den verfügbaren Speicherplatz 
auf Volumes an. Dieses Feld kann nicht bearbeitet 
werden. 

Dateikommentar (File Comment) – zeigt in die 
Datei integrierte Anmerkungen an. BWF- und SD II-
Dateien unterstützen Dateianmerkungen (AIFF-
Dateien jedoch nicht). Dateianmerkungen bleiben 
auch nach dem Kopieren, Konvertieren oder 
Übertragen einer Datei erhalten. Weitere Hinweise 
finden Sie unter „Anmerkungsfelder“ auf Seite 296.

Database Comment – in der Datenbank 
gespeicherte Benutzeranmerkungen werden mit 
Unterstützung für Finder-Anmerkungen 
angezeigt. Weitere Hinweise finden Sie unter 
„Anmerkungsfelder“ auf Seite 296.

Änderungsdatum (Date Modified) – gibt das 
Datum der letzten Änderung des Elements an. 
Dieses Feld kann nicht bearbeitet werden.

Erstellungsdatum (Date Created) – gibt das 
Erstellungsdatum des Elements an. Dieses Feld 
kann nicht bearbeitet werden. 

Anzahl der Kanäle – zeigt die Anzahl der Kanäle 
in einer Audiodatei an: Mono, Stereo oder 3–8 für 
unterstützte Mehrkanal-Dateien. Dieses Feld kann 
nicht bearbeitet werden.

Format – zeigt das Format der Audiodatei an: 
WAV, WAV (ACID) für ACID-Dateien, WAV 
(BWF), AIFF, MP3 oder ReCycle für REX-
Dateien. Dieses Feld kann nicht bearbeitet werden. 

Sample Rate – zeigt die Samplerate einer Audiodatei 
an. Dieses Feld kann nur in Workspace-Browsern 
für WAV- und SD II-Dateien bearbeitet werden. 

Weitere Informationen finden Sie unter 
„Volume-Berechtigungen“ auf Seite 286.

SD II-Dateien, die für den Import in 
Pro Tools vorgesehen sind, müssen in ein 
unterstütztes Audiodateiformat konvertiert 
werden (WAV oder AIF).
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Diese Funktion ist hilfreich, wenn Sie mit der Pull 
Up/Pull Down-Funktion bearbeitete Audiodaten 
verwenden oder wenn vor dem Importieren von 
Dateien, für die normalerweise keine 
Konvertierung erforderlich ist, eine Samplerate-
Konvertierung durchgeführt werden soll.

Bit Depth. – zeigt die Bitrate einer Audiodatei an. 
Dieses Feld kann nicht bearbeitet werden.

Tempo. – zeigt das Tempo an, das mit Clipgruppen-, 
MIDI-, tickbasierten Elastic Audio-Dateien, REX- 
und ACID-Dateien sowie Session-Dateien verknüpft 
ist. Dieses Feld kann nicht bearbeitet werden.

Video Compression. – zeigt ggf. das 
Komprimierungsverhältnis von Videodateien an.

Frame Rate. – zeigt die Framerate von 
Videodateien an, wo zutreffend.

Originalzeitstempel. – zeigt den 
Originalzeitstempel (Timecode-Position) von 
Audio- oder Videodateien an.

Benutzerzeitstempel. – zeigt ggf. den Anwender-
Zeitstempel der Audiodateien an.

Path. – zeigt den Verzeichnispfad des Elements an. 

Unique ID. – zeigt die eindeutige ID einer 
Pro Tools-Datei. 

Clip-Name. – zeigt den Namen der Datei oder den 
Avid-Clipnamen (bei einer AAF- oder OMF-Datei) 
an. Nach dem Importieren einer Datei in eine Session 
wird der Clipname in der Timeline und der Clipliste 
angezeigt. Dieses Feld kann nur in den Katalogen 
bearbeitet und im Browser-Menü mit einem der 
Befehle zum Kopieren der Anmerkungen in den 
Clipnamen erstellt werden (siehe „Zusätzliche 
Workspace-Befehle in Katalogen“ auf Seite 292). 

Band (Tape). – wenn es sich bei dem Element um 
eine OMF-Datei (Audio oder Video) handelt, wird in 
dieser Spalte der ursprüngliche Avid-Bandname 
angezeigt. Wenn die Audiodatei in einer Pro Tools-
Session aufgenommen wurde, wird in diesem Feld 
der Name der ursprünglichen Session angezeigt. 

TC Rate – handelt es sich bei dem Element um 
eine AAF-Sequenz, eine OMF-Sequenz oder -
Datei, dann wird in dieser Spalte die Framerate des 
ausgewählten Elements angezeigt. Die möglichen 
Werte sind: 24, 25, 29,97, 30 im Drop- oder Non-
Drop-Format. Bei Sequenzen wird die Framerate 
am Beginn der Sequenz angezeigt.

Kanalnamen (Channel Name) – zeigt die 
Kanalnamen und -nummern an, die in Mehrkanal-
Audiodateien eingebettet sind. Sie können den 
Kanalnamen nur für BWF-Monodateien bearbeiten. 
Beim Bearbeiten des Kanalnamens werden alle 
Eingaben in Klammern verworfen. Jedoch wird die 
Kanalnummer stets beibehalten.

Szene (Scene) – zeigt die Szenennummerndaten 
an, die in Audiodateien eingebettet sind. 

Take – zeigt die Take-Nummerndaten an, die in 
Audiodateien eingebettet sind.

Drehdatum (Shoot Date) – zeigt die in Audiodateien 
eingebetteten Informationen zu Ursprungsdatum und -
zeit an. Viele tragbare Rekorder füllen jedoch das 
Shoot Date-Feld nicht aus, sondern geben das 
Produktionsdatum anhand des Erstellungsdatums der 
Datei an. Wenn Pro Tools eine Datei aus einem 
tragbaren Rekorder importiert, wird überprüft, ob das 
Shoot Date-Feld Daten enthält. Wenn es leer ist, 
kopiert Pro Tools das Erstellungsdatum der 
ursprünglichen Quelldatei in das Shoot Date-Feld der 
neuen importierten Dateien. Dieses Feld kann nicht 
bearbeitet werden.

Tonrolle (Sound Roll) – zeigt das Datum der 
Tonrollennummer an (diese Daten werden in 
BWF-Dateien in der Regel als „Tape“ bezeichnet, 
unterscheiden sich jedoch von dem Datum, das in 
der Tape-Spalte von Workspace angezeigt wird). 
Dieses Feld kann nicht bearbeitet werden.

Tonrollen-TC – zeigt den Start-Timecode von 
Audiodateien an. Dieses Feld kann nicht bearbeitet 
werden.
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Tonrollen-TC-Rate – zeigt die in Audiodateien 
eingebetteten Informationen zur Framerate an. Die 
möglichen Werte sind: 24, 25, 29, 97, 30 im Drop- 
oder Non-Drop-Format. Dieses Feld kann nicht 
bearbeitet werden.

User Bits – zeigt die in Audiodateien eingebetteten 
Textinformationen an. Dieses Feld kann für 
Anwenderkommentare oder für bei bestimmten 
transportablen Rekordern automatisch generierte 
Informationen verwendet werden.

Band-ID (Tape ID) – zeigt die in Audiodateien 
eingebetteten Band-ID-Informationen an. Dieses 
Feld kann nicht bearbeitet werden.

Projekt – zeigt die in Audiodateien eingebetteten 
Projektnamendaten an.

Circled – zeigt an, ob der Status eines Takes in 
Audiodateien auf „circled“ (No oder Yes) gesetzt 
ist. Dadurch wird in der Regel angegeben, welcher 
Take verwendet werden soll.

Plug-In Name – zeigt den Namen des Plug-Ins für 
die Plug-In-Einstellungsdateien (.txf) an.

Plug-In Manufacturer Name – zeigt den Namen 
des Plug-In-Herstellers für Plug-In-
Einstellungsdateien (.txf) an.

Link Path – zeigt den Pfad der für das erneute 
Koppeln verwendeten Datei an. Dieses Feld ist nur 
im Relink-Fenster verfügbar.

Anmerkungsfelder
Die Anmerkungen zu den einzelnen Dateien werden 
in der Datenbank gespeichert und können mit dem 
Metadaten-Wrapper der Datei integriert werden. 
Es gibt folgende zwei Arten von Anmerkungsfeldern: 
Dateianmerkungen (File Comments) und 
Datenbankanmerkungen (Database Comments).

Dateianmerkungen

Die Dateianmerkungen werden zusammen mit den 
Metadaten der Datei gespeichert. Nicht alle 
Dateitypen unterstützen Dateianmerkungen. Beim 
Indizieren werden Dateianmerkungen in der 
Datenbank gespeichert und können folglich auch 
„offline“ angezeigt und durchsucht werden. 
Dateianmerkungen können in Workspace-Browsern 
bearbeitet werden, es sei denn, die Dateien oder die 
übergeordneten Medien sind schreibgeschützt. 

Außerdem können Sie Dateianmerkungen von 
Pro Tools-Session-Dateien hinzufügen und 
bearbeiten. Dateianmerkungen können nicht in 
Katalogen bearbeitet werden.

Datenbankanmerkungen

(Nur Sessions und Kataloge)

Datenbankanmerkungen können durchsucht und 
bearbeitet werden, sind plattformunabhängig und 
dürfen maximal 256 Zeichen lang sein. Weitere 
Informationen finden Sie unter 
„Anmerkungsfelder“ auf Seite 296. 

Hinzufügen und Bearbeiten von 
Anmerkungen

So können Sie eine Anmerkung hinzufügen, 
anzeigen oder bearbeiten:

1 Klicken Sie in das Comments-Feld. 
Gegebenenfalls wird die Anzeige des Felds 
erweitert, sodass Sie den gesamten Inhalt 
anzeigen können. 

2 Geben Sie eine Anmerkung ein oder bearbeiten 
Sie sie. 

3 Drücken Sie die Eingabetaste oder klicken 
Sie außerhalb des Textfelds, um das Feld 
zu schließen. 
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Auswählen von Elementen
So wählen Sie ein einzelnes Element im Locations-
Bereich aus:

 Klicken Sie auf das Symbol eines Elements. 
Ein Element ist ausgewählt, wenn es 
hervorgehoben ist. Die Inhalte der ausgewählten 
Elemente (Volume, Ordner, Session oder Katalog) 
werden im Browser-Bereich angezeigt.

So wählen Sie mehrere Elemente im Browser-
Bereich aus:

 Wählen Sie eine Gruppe von Elementen durch 
Ziehen aus oder klicken Sie mit gedrückter 
Umschalttaste auf zusätzliche Elemente. 
Um mehrere nicht nebeneinander liegende 
Elemente auszuwählen, klicken Sie bei 
gedrückter Befehls- (Mac) bzw. Strg-Taste 
(Windows) auf jedes einzelne Element. 

So wählen Sie alle aufgeführten Elemente aus:

 Drücken Sie Befehl + A (Mac) bzw. Strg + A 
(Windows).

So wählen Sie alle Transfer-Dateien im aktuellen 
Fenster aus:

 Wählen Sie im Browser-Menü Select 

Transfer Files.

So wählen Sie alle Offline-Dateien aus:

 Wählen Sie im Browser-Menü Select 
Offline Files.

So wählen Sie alle Online-Dateien aus:

 Wählen Sie im Browser-Menü Select 
Online Files.

So kehren Sie die aktuelle Auswahl um:

 Wählen Sie im Browser-Menü Invert Selected. 

Verschieben, Kopieren, 
Duplizieren und Entfernen 
von Elementen
Das Verschieben, Kopieren, Duplizieren und 
Entfernen von Elementen in Workspace-Browsern 
folgt denselben Regeln und Verhaltensweisen wie im 
Betriebssystem. Beispielsweise wird durch das 
Verschieben einer Datei auf ein anderes Volume die 
Datei kopiert. Pro Tools gibt eine Warnung aus, 
wenn durch diesen Vorgang Elemente überschrieben 
oder ersetzt würden. Durch das Ziehen eines 
Elements von einem Katalog-Browser in einen 
Volume-Ordner wird immer eine Kopie des 
Elements erstellt. 

Verschieben von Elementen

So verschieben Sie Elemente:

 Wählen Sie mindestens ein Element aus und 
ziehen Sie es an die neue Position. Durch das 
Verschieben eines Elements auf demselben 
Volume wird es ausgeschnitten und verschoben, 
während es durch das Verschieben auf ein anderes 
Volume kopiert wird. 

Kopieren von Elementen

So kopieren und verschieben Sie Elemente:

 Wählen Sie mindestens ein Element aus und 
ziehen Sie es mit gedrückter Wahltaste (Mac) bzw. 
Alt-Taste (Windows) an die neue Position. 

Wenn bereits eine Auswahl im Locations-
Bereich oder im Browser-Bereich 
vorgenommen wurde, können Sie auch den 
oder die ersten Buchstaben des Elements 
eingeben, das Sie auswählen möchten.

Sie können Elemente direkt in die 
Timeline oder Clipliste der aktuellen 
Session ziehen. Siehe „Importieren von 
Dateien per Drag & Drop“ auf Seite 329.
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Duplizieren von Elementen

So duplizieren Sie ein oder mehrere Elemente:

1 Wählen Sie ein oder mehrere Elemente aus. 

2 Wählen Sie im Browser-Menü die Duplicate 

Selected-Option.

Entfernen von 
Sessionelementen
In Workspace-Browsern können Sie Dateien aus 
der aktuell geöffneten Session löschen. Ein auf 
einem schreibgeschützten Volume gespeichertes 
Element kann nicht gelöscht werden. Es kann aber 
aus der Session entfernt werden. 

So löschen Sie ein oder mehrere Elemente aus 
einer Session:

1 Wählen Sie die aktuelle Session im 
Locations-Bereich. 

2 Wählen Sie im Browser-Bereich ein oder 
mehrere Elemente aus.

3 Wählen Sie im Browser-Menü Move to Trash 
(Mac) oder Move to Recycle Bin (Windows). 

4 Sie haben folgende Möglichkeiten:

• Klicken Sie auf Remove, um das Element aus 
der Session zu entfernen.

• Klicken Sie auf Delete, um das Element aus dem 
System zu entfernen.

• Klicken Sie auf Cancel, um die ausgewählten 
Elemente nicht zu ändern. 

Suchen von Elementen
In Pro Tools können Sie problemlos Ihr gesamtes 
System oder bestimmte Volumes, Verzeichnisse 
oder Kataloge durchsuchen. Workspace-Browser 
bieten einen einfachen Satz Suchfunktionen, mit 
denen Sie schnell nach Dateien (online und 
offline) in Ihrem System suchen können.

Durch den Suchvorgang werden nur die Elemente 
im Browser-Bereich aufgelistet, die mit den 
Suchkriterien übereinstimmen. 

Das Relink-Fenster bietet spezifische 
Sucheinstellungen für das Suchen und erneute 
Koppeln fehlender Dateien. Weitere 
Informationen finden Sie unter „Koppeln und 
Neukoppeln von Dateien“ auf Seite 310.

Suchfunktionen
Am Anfang jedes Workspace-Browsers befinden 
sich Suchfunktionen zum schnellen und einfachen 
Suchen von Dateien in Ihrem System.

Browser-Suchfeld

Geben Sie Dateinamen, Daten, Dauern und so weiter 
in das Browser-Suchfeld ein. Sobald Sie mit der 
Eingabe beginnen, startet Pro Tools mit der Suche 
nach Treffern für den eingegebenen Text. Die 
Ergebnisse werden im Browser-Bereich angezeigt. 

Drücken Sie im Workspace-Browser den 
Befehl + D (Mac) bzw. Strg + D (Windows), 
um die ausgewählten Elemente zu duplizieren.

Neue Suchfunktionen

Schaltfläche für die erweiterte Suche

Schaltfläche für die einfache Suche

Browser-Suchfeld
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Schaltfläche für die einfache Suche

Klicken Sie auf die Suchschaltfläche, um eine 
einfache Suche zu starten, bevor Sie Text in das 
Browser-Suchfeld eingeben. Die Schaltfläche für die 
einfache Suche ändert sich von einem Lupensymbol in 
ein „X“ und die Suche wird umgehend gestartet. 
Klicken Sie erneut auf die Suchschaltfläche, um die 
Suche zu beenden (oder drücken Sie die Esc-Taste). 

Schaltfläche für die erweiterte Suche

Klicken Sie auf die Schaltfläche für die erweiterte 
Suche, um die Symbolleiste für die erweiterte Suche 
zu öffnen. (Weitere Informationen finden Sie unter 
„Erweiterte Suche“ auf Seite 300.)

Einfache Suche
Pro Tools bietet mit dem Browser-Suchfeld eine 
einfache Textsuche, mit der Sie rasch über den 
Dateinamen alle Volumes sowie alle anderen 
verfügbaren Textfelder im Workspace-Browser 
(wie zum Beispiel File Comment, Database 

Comment, Scene, Take, Plug-In Name und so 
weiter) nach Elementen durchsuchen können.

So starten Sie eine einfache Suche:

1 Wählen Sie im Locations-Bereich das Volume, 
den Katalog, die Session oder den Ordner, 
in dem bzw. der Sie Ihre Suche ausführen 
möchten. Wenn Sie keine Auswahl vornehmen, 
wird das gesamte System durchsucht 
(einschließlich angezeigter Offline-Volumes).

2 Drücken Sie Befehl + F (Mac) bzw. Strg + F 
(Windows).

3 Geben Sie in das Browser-Suchfeld Text ein.

4 Klicken Sie ins Browser-Suchfeld und geben 
Sie Text für die Suche ein.

Die Suchergebnisse werden im Browser-Bereich 
angezeigt.

Bei einer Suche ohne Suchkriterien werden als 
Ergebnis alle Elemente im System angezeigt.
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Erweiterte Suche
Pro Tools bietet erweiterte Funktionen für die Suche nach Dateien und Volumes mit Hilfe von spezifischen 
Kategorien. Sie können Ihre Suche mit dem Festlegen mehrerer Einschränkungen für die Suchparameter 
präzisieren. Sie können auch problemlos von einer erweiterten Suche zu einer einfachen Suche wechseln.

So starten Sie eine erweiterte Suche in einem 
im Locations-Bereich aktivierten Element:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Schaltfläche für die 
erweiterte Suche.

• Drücken Sie Befehl + Umschalt + F (Mac) bzw. 
Strg + Umschalt + F (Windows).

2 Deaktivieren Sie, falls sie aktiviert ist, mit 
einem Klick die Search Checked-Option links 
in der Kopfzeile des Locations-Bereichs.

3 Wählen Sie im Locations-Bereich das Volume, den 
Katalog, die Session oder den Ordner, in dem bzw. 
der Sie Ihre Suche ausführen möchten.

4 Wählen Sie den Spaltentyp.

5 Wählen Sie die Suchkriterien.

6 Klicken Sie in das Suchleisten-Textfeld 
und geben Sie Text für die Suche ein.

7 Drücken Sie Return (Mac) oder 
Eingabe (Windows).

Die Suchergebnisse werden im Browser-
Bereich angezeigt.

Wenn Sie Ihre Suche präzisieren möchten, klicken 
Sie auf die „Add Row“-Schaltfläche, um weitere 
Einschränkungen für die Suche hinzuzufügen. 
Wiederholen Sie die Schritte 4-6 für jede Reihe, 
die Sie hinzufügen möchten.

Ergebnisse der erweiterten Suche für das ausgewählte Volume

Ausgewähltes Volume für die Suche Erweiterte Sucheinstellungen Aktivierte erweiterte Suche

Search Checked-Option 
(deaktiviert)

Suchergebnisse
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So starten Sie eine erweiterte Suche in aktivierten Elementen, die im Locations-Bereich aktiviert sind:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Schaltfläche für die erweiterte Suche.

• Drücken Sie Befehl + Umschalt + F (Mac) bzw. Strg + Umschalt + F (Windows).

2 Aktivieren Sie, falls sie deaktiviert ist, mit einem Klick die Search Checked-Option links in der 
Kopfzeile des Locations-Bereichs.

3 Aktivieren Sie im Locations-Bereich alle Volumes, Kataloge, Sessions oder Ordner, die Sie 
durchsuchen möchten.

4 Wählen Sie den Spaltentyp.

5 Wählen Sie die Suchkriterien.

6 Klicken Sie in das Suchleisten-Textfeld 
und geben Sie Text für die Suche ein.

7 Drücken Sie Return (Mac) oder 
Eingabe (Windows).

Die Suchergebnisse werden im Workspace-
Bereich angezeigt.

Wenn Sie Ihre Suche präzisieren möchten, klicken 
Sie auf die „Add Row“-Schaltfläche, um weitere 
Einschränkungen für die Suche hinzuzufügen. 
Wiederholen Sie die Schritte 4-6 für jede Reihe, 
die Sie hinzufügen möchten.

Erweiterte Suchergebnisse für das aktivierte Volume

 

Aktiviertes Volume für die Suche Erweiterte Sucheinstellungen Aktivierte erweiterte Suche

„Search Checked“-
Option (aktiviert)

Suchergebnisse
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Um von der erweiterten Suche zur einfachen Suche 
zu wechseln, haben Sie folgende Möglichkeiten:

 Klicken Sie auf die Schaltfläche für die erweiterten 
Suche, sodass sie hervorgehoben ist.

 Drücken Sie Befehl + Umschalt + F (Mac) bzw. 
Strg + Umschalt + F (Windows).

Um von der einfachen Suche zur erweiterten Suche 
zu wechseln, haben Sie folgende Möglichkeiten:

 Klicken Sie auf die Schaltfläche für die erweiterte 
Suche, sodass sie nicht hervorgehoben ist.

 Drücken Sie Befehl + F (Mac) bzw. 
Strg + F (Windows).

So beenden Sie die Suche:

 Klicken Sie auf die Schaltfläche für die 
einfache Suche („X“).

Erweiterte Suchfunktionen
Sobald Sie eine erweiterte Suche beginnen, 
zeigt der Workspace-Browser weitere Funktionen 
für die erweiterte Suche an.

Spaltensuche-Selektor

Sie können in allen Spalten nach Text suchen oder 
nur in bestimmten Spalten im Browser.

Suchkriterien-Selektor 

Sie können nach Elementen in der 
ausgewählten Spalte suchen und dabei 
folgende Suchkriterien verwenden: 

Contains. – wählen Sie diese Option, um nach 
Elementen zu suchen, die den Text enthalten, den 
Sie in das Suchleisten-Textfeld eingeben.

Does Not Contain. – wählen Sie diese Option, um 
Elemente von der Suche auszuschließen, die den 
Text enthalten, den Sie in das Suchleisten-Textfeld 
eingeben.

Starts with. – wählen Sie diese Option, um nach 
Elementen zu suchen, die mit dem Text beginnen, 
den Sie in das Suchleisten-Textfeld eingeben.

Contains Exactly. – wählen Sie diese Option, 
um nach Elementen zu suchen, die genau den Text 
enthalten, den Sie in das Suchleisten-Textfeld 
eingeben.

Suchleisten-Textfeld

Verwenden Sie das Suchleisten-Textfeld, um nach 
dem ausgewählten Spaltentyp zu suchen, 
entsprechend dem festgelegten Spaltentyp und den 
Suchkriterien.

„Add/Remove Row“ (Zeile hinzufügen/entfernen)

In Pro Tools können Sie Ihre Suche mit bis zu 
8 Zeilen für Suchkriterien präzisieren.

„Add Row“-Schaltfläche. Klicken Sie auf die 
Add-Schaltfläche („+“), um eine weitere Zeile 
hinzuzufügen und die erweiterte Suche 
zu präzisieren.

„Remove Row“-Schaltfläche. Klicken Sie in 
einer Reihe auf die Remove-Schaltfläche („–“), 
um diese Zeile zu entfernen.

Erweiterte Suchfunktionen

Klicken Sie auf die „Add Row“-Schaltfläche (+).

Suchleisten-Textfeld

Suchspalten-Selektor

Suchkriterien-Selektor

„Remove Row“-Schaltfläche Drücken Sie Umschalt + „+“ (Plus), 
um eine neue Zeile hinzuzufügen.

Drücken Sie Umschalt + „–“ (Minus), 
um die unterste Zeile zu entfernen.
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Speichern der Suchergebnisse 
als Katalog

So speichern Sie die Ergebnisse der Suche 
als Katalog:

1 Wählen Sie Edit > Select All oder drücken Sie 
Befehl + A (Mac) bzw. Strg + A (Windows), 
um alle Elemente der Elementliste auszuwählen.

2 Wählen Sie im Browser-Menü Create Catalog.

Wellenformen
In der Spalte „Waveform“ werden Wellenformen 
für Audiodateien angezeigt. Die Anzeige der 
Wellenformen hängt von den folgenden 
Voraussetzungen ab:

• Die Wellenformen werden angezeigt, wenn sie 
bereits berechnet und gespeichert wurden 
(entweder in den Datei-Metadaten oder 
im allgemeinen Cache für Wellenformen).

• Wenn eine Datei in eine Session importiert wird, 
wird automatisch eine Wellenform für die Datei 
berechnet. 

Die Wellenformübersichten werden in der Datei oder 
im Pro Tools Databases-Ordner auf Ihrem 
Systemlaufwerk gespeichert. Weitere Informationen 
finden Sie unter „WaveCache“ auf Seite 303.

Zusammengeführte Wellenformen 
für Mehrkanaldateien

Die Wellenformanzeige für Stereo- und 
Mehrkanaldateien wird zusammengeführt. 

Berechnen der Wellenformen für 
die Anzeige
Wenn ein Audiodatei-Element keine Wellenform 
hat, muss diese berechnet werden, damit sie in der 
Wellenform-Anzeige eines Workspace-Browsers 
sichtbar ist. 

So berechnen Sie Wellenformen in einem 
Workspace-Browser:

1 Wählen Sie Online-Audiodateien oder Ordner, 
die Audiodateien enthalten, in einem 
Workspace-Browser aus.

2 Wählen Sie aus dem Browser-Menü 
die Calculate Waveform-Option. 

WaveCache
In der allgemeinen WaveCache-Datei für 
Wellenformen werden Wellenformen gespeichert, 
die nicht mehr in die Audiodatei geschrieben werden 
können, wie etwa schreibgeschützte Dateien, 
Netzwerkdateien, andere schreibgeschützte Volumes 
und Interleaved-Dateien.

Auf dem Mac ist die WaveCache-Datei 
in /Users/Shared/Pro Tools gespeichert.

Auf Windows ist die WaveCache-Datei 
in <Systemdrive>/Users/Public/ 
Pro Tools gespeichert.

Weitere Informationen finden Sie unter 
„Kataloge“ auf Seite 318.

Wellenform-Anzeigen in einem Workspace-Browser
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Elastic Audio-Dateien 
im Workspace
Sie können die Elastic Audio-Analyse für 
ausgewählte Audiodateien in Workspace-Browsern 
berechnen und zurücksetzen. Die Elastic Audio-
Analyse und -Verarbeitung wird nur für AIFF- 
und WAV-Dateien unterstützt. Alle anderen 
Dateiformate (beispielsweise MP3) müssen für die 
Elastic Audio-Analyse und -Verarbeitung in das 
AIFF- oder WAV-Format konvertiert werden.

So berechnen Sie die Elastic Audio-Analyse:

1 Wählen Sie die Dateien für die Analyse 
in einem Workspace-Browser aus.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie im Browser-Menü Calculate 

Elastic Analysis.

• Klicken Sie mit der rechten Maustaste auf eine 
der ausgewählten Dateien und wählen Sie 
im Popup-Menü Calculate Elastic Analysis.

• Hören Sie die Datei mit aktivierter Audio Files 

Conform to Session Tempo-Option ab.

Analysierte Dateien, in denen ein regelmäßiges 
Tempo erkannt wurde, werden ebenfalls 
als tickbasiert aktualisiert, ihre Dauer wird 
in Bars|Beats angezeigt und ihr ursprüngliches 
Tempo wird in der Spalte „Tempo“ angezeigt. 

Analysierte Dateien, in denen kein Tempo erkannt 
wurde, bleiben samplebasiert. Diese Dateien 
enthalten normalerweise nur eine einzige 
Signalspitze (etwa einen Snare-Schlag) oder es sind 
längere Dateien ohne mühelos erkennbares 
regelmäßiges Tempo (etwa ganze Songs).

So setzen Sie die Elastic Audio-Analyse zurück:

1 Wählen Sie in einem Workspace-Browser mit 
der Elastic Audio-Analyse die Dateien aus, 
die Sie löschen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie im Browser-Menü Clear 

Elastic Analysis.

• Klicken Sie mit der rechten Maustaste auf eine 
der ausgewählten Dateien und wählen Sie im 
Popup-Menü die Clear Elastic Analysis-Option.

Dateien, in denen die Elastic Audio-Analysedaten 
entfernt wurden, kehren zur samplebasierten 
Zeitbasis zurück, ihre Dauer wird in Minuten und 
Sekunden angezeigt und es wird kein Tempo für 
sie angezeigt.

Das Dateiformat MP3 wird zwar nicht direkt 
von Elastic Audio unterstützt, aber Sie 
können es in eine WAV- oder AIFF-basierte 
Session importieren und anschließend 
die konvertierten Dateien auf Spuren 
mit aktiviertem Elastic Audio verwenden. 
Dateiformate, die der Session nicht 
entsprechen, werden beim Importieren 
automatisch konvertiert.

Weitere Informationen finden Sie unter 
Kapitel 40: „Elastic Audio“.

Wenn auf dem Mac das Elastic Audio Analysis-
Symbol nicht angezeigt oder die Dauer 
während des Vorhörens nicht in tickbasiert 
geändert wird, prüfen Sie im Mac Finder die 
Zugriffsrechte für den Ordner. Sie benötigen 
das Schreibrecht für das Verzeichnis, damit 
diese Funktion arbeitet.
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Symbole für Datei-Zeitbasis und 
Elastic Audio-Analyse
Workspace-Browser enthalten zwei verschiedene 
Symbole für zeitbasierte und für tickbasierte Dateien. 
Für zeitbasierte Dateien ist das zeitbasierte Symbol 
farblich kodiert, um anzuzeigen, ob eine Datei eine 
Elastic Audio-Analyse enthält.

Symbol für samplebasierte Datei – zeigt an, 
dass die Datei samplebasiert ist. Das zeitbasierte 
Symbol ist farblich kodiert, um anzuzeigen, ob eine 
Datei Daten einer Elastic Audio-Analyse enthält. 
Samplebasierte WAV- und AIF-Dateien ohne Elastic 
Audio-Analysedaten werden als graue Uhr 
dargestellt. Samplebasierte WAV- und AIF-Dateien 
mit Elastic Audio-Analysedaten werden als blaue 
Uhr dargestellt. Die Dauer der Datei wird in Minuten 
und Sekunden angezeigt. 

Symbol für tickbasierte Datei – zeigt an, dass die 
Datei tickbasiert ist. Die Dauer der Datei wird 
in Bars|Beats angezeigt und das ursprüngliche 
Tempo der Datei wird in der Spalte „Tempo“ 
angegeben. MIDI-, REX- und ACID-Dateien sind 
tickbasiert und enthalten ihre eigenen Tempo- und 
Takt|Schlag-Metadaten. Tickbasierte WAV- und 
AIF-Dateien mit Elastic Audio-Analyse werden auch 
als Symbol mit grünem Metronom dargestellt.

Vorhören von Audio in 
Workspace-Browsern
Audiodateien können in Workspace-Browsern 
angezeigt abgehört werden. Das Vorhören 
entspricht dem im Output-Fensterbereich des 
I/O Setup-Dialogfelds angegebenen Hauptpfad für 
das Abhören (siehe „Abhörpfade“ auf Seite 78). 
Der Basispegel für das Vorhören wird durch den 
Pegel des dem Abhörpfad zugewiesenen Master-
Faders (oder Auxiliary-Eingangs) bestimmt. 
Sie können im Workspace-Browser auch 
die Lautstärke zum Vorhören einstellen.

So hören Sie eine Audiodatei in einem Workspace-
Browser ab:

1 Wählen Sie eine Audiodatei in der Elementliste 
des Browsers. Vergewissern Sie sich, dass der 
Workspace-Browser im (aktiven) Fenster 
im Vordergrund ist. 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Schaltfläche für die 
Wellenformvorschau (das Lautsprechersymbol 
links neben der Wellenformanzeige). Klicken 
Sie erneut, um das Abhören zu stoppen.

• Wenn die Spacebar Toggles File PreviewOption 
im Browser-Menü ausgewählt ist, drücken Sie 
die Leertaste. Drücken Sie die Leertaste erneut, 
um das Abhören anzuhalten.

• Drücken Sie Befehl + P (Mac) bzw. Strg + P 
(Windows), um das Vorhören zu starten 
und anzuhalten. 

Symbole für Elastic Audio und Zeitbasis in 
Workspace-Browsern

Symbol für 
samplebasierte Elastic 
Audio-Dateien

Symbol für 
tickbasierte 
Datei

Symbol für 
samplebasierte Datei 
ohne Elastic Audio
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• Auch über die Esc-Taste kann das Vorhören 
angehalten werden. 

So können Sie eine Audiodatei ab einer 
bestimmten Stelle abhören:

 Klicken Sie in der Wellenformanzeige auf die 
entsprechende Stelle. 

Interleaved-Dateien

Für das Vorhören in Workspace-Browsern werden 
Interleaved-Audiodateien mit mehr als zwei Kanälen 
zu einem Monokanal zusammengefasst. 

Multimono-Dateien

Multimono-Dateien können nur einzeln vorgehört 
werden. 

Gemeinsames Vorhören gesplitteter 
Stereodateien

Wenn Sie eine Datei eines Paars gesplitteter 
Stereodateien auswählen (wie „Drums.L“ und 
„Drums.R“), werden beide Dateien zusammen 
vorgehört. Um nur den ausgewählten Kanal eines 
gesplitteten Stereodateienpaars vorzuhören, drücken 
Sie die Umschalttaste und starten Sie das Vorhören.

Vorhören-Steuerelemente 
und -Anzeigen
In jedem Workspace-Browser werden die 
folgenden Preview-Steuerelemente in der 
Symbolleiste angezeigt: Preview, Lautstärke, 
Pegelanzeigen, Audio Files Conform to Session 
Tempo und Elastic Audio-Plug-In.

Preview-Schaltfläche

Über die Vorhören-Schaltfläche können Sie das 
Vorhören von Audiodateien, die in Workspace-
Browsern ausgewählt sind, starten und stoppen. 
Sie können auch mit der rechten Maustaste auf 
die Vorhören-Schaltfläche klicken, um den 
Vorhörmodus zu ändern und festzulegen, ob die das 
Vorhören der Datei über die Leertaste ein- oder 
ausgeschaltet wird. 

Wenn die Auto-Preview-Option aktiviert ist, wird 
das Vorhören gestartet, sobald die Datei in 
einem Workspace-Browser ausgewählt wird.

Abhören einer Audiodatei

Einige Pro Tools-Vorgänge können 
während des Abhörens in Workspace 
zeitweilige Ausfälle verursachen. 

MIDI-Dateien können aus der Clipliste der 
Session vorgehört werden, jedoch nicht aus 
Workspace-Browsern. Siehe „Vorhören 
von Clips in der Clipliste“ auf Seite 276.

Vorhören-Steuerelemente in Workspace-Browsern

Workspace-Browser, Vorhören-Schaltfläche, 
Kontextmenü

Audio Files Conform to 
Session Tempo-SchaltflächeVorhören-

Schaltfläche
Volume

Pegelanzeigen
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Volume

Der Lautstärkeregler in Workspace-Browsern 
ermöglicht es, die Lautstärke beim Vorhören 
ausgewählter Dateien zu erhöhen oder 
zu reduzieren. 

So ändern Sie die Lautstärke für das Vorhören 
in Workspace-Browsern:

1 Klicken Sie in das Lautstärkefeld, um den 
Lautstärke-Fader einzublenden.

2 Passen Sie den Lautstärke-Fader an 
(von –INF bis +12 dB).

Pegelanzeigen

In den Pegelanzeigen wird der Audiopegel angezeigt. 
Außerdem liefern sie Übersteuerungsanzeigen. 
Bei Monodateien wird das Monosignal in beiden 
Pegelanzeigen angezeigt. Bei Stereodateien zeigen die 
linke und die rechte Pegelanzeige den linken bzw. den 
rechten Kanal an. Mehrkanaldateien, die über Stereo 
hinausgehen, werden in beiden Pegelanzeigen als 
summiertes Mono angezeigt.

Audio Files Conform to Session Tempo-
Schaltfläche

Die Audio Files Conform to Session Tempo-
Schaltfläche gleicht dem entsprechenden Befehl 
im Browser-Menü. Wenn diese Option aktiviert 
ist, werden alle tickbasierten Audiodateien mit 
Elastic Audio-Analyse, ebenso wie REX- und 
ACID-Dateien, an das Tempo der Session 
angeglichen. Auf diese Weise können Sie die 
Session wiedergeben und dann simultan die 

ausgewählten Dateien in zeitlicher 
Übereinstimmung mit der Session vorhören. 
Die Schaltfläche „Audio Files Conform to Session 
Tempo“ ist nur verfügbar, wenn eine Session 
geöffnet ist. Ansonsten ist sie deaktiviert und wird 
abgeblendet dargestellt.

Wenn die Option „Audio Files Conform to Session 
Tempo“ aktiviert ist, analysiert Pro Tools nicht 
analysierte Dateien beim Vorhören oder beim 
Import. Tickbasierte Audiodateien werden beim 
Vorhören oder beim Import an das Session-Tempo 
angeglichen. Samplebasierte Dateien, für die kein 
Tempo erkannt wurde, behalten beim Vorhören 
oder beim Import immer die 
Originalgeschwindigkeit und -dauer bei.

Wenn die Audio Files Conform to Session Tempo-
Option deaktiviert ist, werden alle tickbasierten 
Audiodateien mit Elastic Audio-Analyse sowie 
REX- und ACID-Dateien in ihrem ursprünglichen 
Tempo vorgehört. 

Elastic Audio-Plug-In-Selektor

Mit dem Elastic Audio Plug-In-Selektor können 
Sie jedes Echtzeit-Elastic Audio-Plug-In als 
Standard-Plug-In für das Vorhören und 
das Importieren von Elastic Audio-Dateien 
verwenden. Wenn Sie das Plug-In in einem 
Workspace-Browser ändern, wirkt sich dies auch 
auf die Elastic Audio Default Plug-In-Option in den 
Processing-Einstellungen aus.

So verwenden Sie das Elastic Audio-Plug-In für 
das Vorhören im Kontext:

1 Klicken Sie mit der rechten Maustaste auf 
die „Audio Files Conform to Session 
Tempo“-Schaltfläche.

Workspace-Browser, Lautstärke-Fader für Vorhören

Weitere Informationen finden Sie unter 
„Angleichen an das Session-Tempo beim 
Vorhören“ auf Seite 309
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2 Wählen Sie das gewünschte Elastic Audio-
Plug-In.

Vorhörmodi
Die Workspace-Browser bieten drei Vorhör-Modi: 
Normales Vorhören, Loop-Vorhören und 
Auto-Vorhören.

Normales Vorhören
Beim normalen Vorhören wird einfach 
die ausgewählte Datei wiedergegeben und das 
Vorhören stoppt am Ende der Datei. Deaktivieren 
Sie das Loop-Vorhören und das Auto-Vorhören für 
den normalen Vorhörmodus.

Loop-Vorhören
Beim Loop-Vorhören wird die ausgewählte Datei in 
einer wiederholten Schleife wiedergegeben. Wenn 
Sie mehrere Dateien ausgewählt haben, wird nur die 
erste ausgewählte Datei vorgehört. Wenn der Loop-
Vorhörmodus aktiviert ist, wird auf der Vorhören-
Schaltfläche das Symbol für den Loop-
Vorhörmodus angezeigt.

So können Sie mittelsLoop-Vorhören eine Datei 
in einem Workspace-Browser vorhören:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie im Browser-Menü Loop Preview. 
Die Vorhören-Schaltfläche wird so aktualisiert, 
dass das Symbol für das Loop-Vorhören 
angezeigt wird.

• Klicken Sie mit der rechten Maustaste auf 
die Vorhören-Schaltfläche und wählen 
Sie „Loop Preview“.

2 Wählen Sie eine Audiodatei in der Elementliste 
des Workspace-Browsers. Vergewissern 
Sie sich, dass der Workspace-Browser im 
(aktiven) Fenster im Vordergrund ist. 

3 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Browser Preview-Schaltfläche.

• Klicken Sie auf die Waveform Preview-
Schaltfläche.

• Wenn die Spacebar Toggles File PreviewOption 
im Browser-Menü ausgewählt ist, drücken 
Sie die Leertaste.

• Drücken Sie Befehl + P (Mac) bzw. Strg + P 
(Windows). 

So können Sie das Abhören eines Loops anhalten:

 Sie haben folgende Möglichkeiten:

• Klicken Sie erneut auf die Browser Preview-
Schaltfläche.

• Wenn die Spacebar Toggles File PreviewOption 
im Browser-Menü ausgewählt ist, drücken 
Sie erneut die Leertaste.

• Drücken Sie Befehl + P (Mac) bzw. 
Strg + P (Windows). 

• Drücken Sie die Esc-Taste. 

Workspace-Browser, Auswählen von Elastic Audio-
Plug-In für das Vorhören von Elastic Audio-Dateien.

Weitere Informationen finden Sie unter 
„Elastic Audio-Plug-Ins“ auf Seite 913.

Halten Sie die Ctrl-Taste (Mac) bzw. Windows-
Taste (Windows) gedrückt, während Sie auf die 
Vorhören-Schaltfläche klicken, um den Loop-
Vorhörmodus zu aktivieren bzw. 
zu deaktivieren.

Workspace Vorhören-Schaltfläche, Loop-Vorhörmodus
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Auto-Preview
Wenn das automatische Vorhören aktiviert ist, 
wird die Audiodatei abgespielt, sobald sie 
ausgewählt ist. Zusätzlich wird die Vorhören-
Schaltfläche so aktualisiert, dass ein Symbol für 
das automatische Vorhören angezeigt wird.

So werden Dateien automatisch bei der 
Auswahl vorgehört:

 Sie haben folgende Möglichkeiten:

• Wählen Sie im Browser-Menü Auto-Preview. 
Die Vorhören-Schaltfläche wird aktualisiert und 
zeigt an, dass „Auto-Preview“ aktiviert ist.

• Klicken Sie mit rechten Maustaste auf 
die Vorhören-Schaltfläche, und wählen Sie 
„Auto-Preview“.

Angleichen an das Session-
Tempo beim Vorhören
In Pro Tools ist das Vorhören von mit Elastic Audio 
analysierten Dateien im Session-Tempo möglich. 
Das ausgewählte Standard-Plug-In für Elastic Audio 
wird verwendet, um mit Elastic Audio analysierte 
Audiodateien im Session-Tempo vorzuhören. 
Zusätzlich können auch andere tickbasierte Dateien, 
beispielsweise REX- und ACID-Dateien, im 
Session-Tempo und gleichzeitig mit der Wiedergabe 
vorgehört werden. 

So hören Sie Dateien im Session-Tempo vor:

1 Positionieren Sie den Einfügepunkt in der 
Session an der Position, an der Sie die Datei in 
Workspace vorhören möchten.

2 Wählen Sie die Datei für das Vorhören in einem 
Workspace-Browser aus.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie auf die Audio Files Conform 
to Session Tempo-Schaltfläche. Sie wird 
markiert, wenn sie aktiviert ist.

• Wählen Sie im Browser-Menü Audio Files 

Conform to Session Tempo.

• Klicken Sie mit der rechten Maustaste auf die 
Datei, die Sie vorhören möchten, und wählen 
Sie im Popup-Menü die Audio Files Conform 

to Session Tempo-Option aus.

4 Klicken Sie auf die Vorhören-Schaltfläche 
im Workspace-Browser. Daraufhin wird die 
Datei im Session-Tempo wiedergegeben.

Vorhören im Kontext
Pro Tools ermöglicht das Vorhören von 
Audiodateien in Workspace-Browsern während 
der Wiedergabe in einer Pro Tools-Session. 
Tickbasierte Audiodateien (Dateien, für die bei der 
Elastic Audio-Analyse ein Tempo erkannt wurde, 
sowie REX- und ACID-Dateien) können bei der 
Session-Wiedergabe im Tempo und an der 
entsprechenden Taktposition wiedergegeben 
werden. Tickbasierte Audiodateien werden im 
Session-Tempo abgehört, wenn die Audio Files 

Conform to Session Tempo-Option aktiviert ist. 

Halten Sie die Befehlstaste (Mac) bzw. die 
Strg-Taste (Windows) gedrückt, während Sie 
auf die Vorhören-Schaltfläche klicken, um 
den automatischen Vorhörmodus zu 
aktivieren bzw. zu deaktivieren.

Workspace-Vorhören-Schaltfläche, automatisches 
Vorhören aktiviert

Deaktivieren Sie die Spacebar Toggles File 
Preview-Option im Browser-Menü, um die 
Session-Wiedergabe über die Leertaste 
starten und anhalten können, ohne im 
Workspace-Browser vorzuhören. Drücken Sie 
Befehl + P (Mac) bzw. Strg + P (Windows), 
um das Vorhören in dem Workspace-Browser, 
der als oberstes Fenster angezeigt wird, 
während der Session-Wiedergabe zu starten 
und anzuhalten. 
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Reservieren von Voices für Vorhören 
im Kontext
(Nur Pro Tools HD)

Für das Vorhören im Kontext (das Vorhören von 
Audiodateien im Workspace während der Session-
Wiedergabe) werden Festplatten-Voices für 
die Wiedergabe verwendet. Die Anzahl der 
erforderlichen Voices ist abhängig von der 
Kanalanzahl der ausgewählten Abhörpfade auf der 
Output-Registerkarte des I/O Setup-Dialogfelds. 
Wenn beispielsweise ein Stereo-Abhörpfad im I/O 
Setup ausgewählt ist, werden zwei Voices für das 
Vorhören im Kontext benötigt, während bei einem 
5.1-Abhörpfad sechs Voices erforderlich sind. Wenn 
eine oder mehrere Voices für das Vorhören im 
Kontext nicht verfügbar sind, weil sie für 
Festplattenspuren (oder zum Routen der Native-
Verarbeitung in Pro Tools|HDX-Systemen) 
verwendet werden, ist die Vorhören-Schaltfläche in 
Workspace-Browsern während der Session-
Wiedergabe nicht verfügbar. 

Pro Tools bietet eine Option zum Reservieren von 
Voices für das Vorhören im Kontext. Die Anzahl 
der reservierten Voices wird durch die 
Kanalanzahl der ausgewählten Abhörpfade auf der 
Output-Registerkarte des I/O Setup-Dialogfelds 
bestimmt. Voices, die für das Vorhören im 
Kontext reserviert sind, sind für Festplattenspuren 
nicht verfügbar.

So reservieren Sie Voices für das Vorhören 
im Kontext: 

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Operation-Registerkarte.

3 Aktivieren Sie die Reserve Voices For Preview 

In Context-Option.

4 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

Koppeln und Neukoppeln 
von Dateien
Eine Pro Tools-Session besteht aus Referenzen zu 
Audiodateien und anderen Medien. Diese sind mit 
der Session gekoppelt. Damit Audio- und 
Videodateien in einer Session abgespielt werden 
können, müssen sie nicht nur korrekt gekoppelt, 
sondern auch auf geeigneten Performance-
Volumes gespeichert sein.

Folgende Dateien können nicht abgespielt werden:

Transfer-Dateien – Dateien auf Volumes, die nicht 
zur Wiedergabe geeignet sind (etwa Netzlaufwerke 
oder CD-ROMs).

Fehlende Dateien – Dateien, die nicht 
am erwarteten Speicherort gefunden werden, 
da sie entweder verschoben oder auf Volumes 
gespeichert wurden, die derzeit nicht bereitgestellt 
sind (Offline-Volumes).

Das erneute Einlesen von fehlenden Dateien wird 
als Relinking oder „erneut koppeln“ bezeichnet. 
Dabei ist möglicherweise eine Reihe von 
untergeordneten Vorgängen erforderlich.

• Transfer-Dateien müssen zunächst auf 
ein geeignetes Performance-Volume kopiert 
werden. Die Session wird dann mit den Kopien 
auf dem Performance-Volume (statt der 
ursprünglichen Transfer-Dateien) gekoppelt.

• Volume können nach fehlenden Dateien 
durchsucht werden. Wenn dabei Dateien gefunden 
werden, kann Pro Tools die Session mit den 
Dateien am neuen Speicherort koppeln.

• Bei Dateien auf Offline-Volumes muss das 
Volume bereitgestellt werden, damit es online 
zur Verfügung steht. Erst dann können 
die Dateien erneut gekoppelt werden.

Kataloge sind mit speziellen Kopplungsfunktionen 
ausgestattet. Siehe „Neukopplung und Aliase 
in Katalogen“ auf Seite 318. 
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Der richtige Zeitpunkt 
zum Koppeln
In Pro Tools können Dateien während oder 
nach dem Öffnen einer Session erneut 
gekoppelt werden:

 Wenn Sie die Session während des Öffnens 
koppeln, stehen alle Medien in der Session 
zum Abspielen zur Verfügung. Medien können 
automatisch oder manuell gekoppelt werden. 
Siehe „Öffnen einer Session mit fehlenden 
Dateien“ auf Seite 312. 

 Wenn Sie die Session erst nach dem Öffnen 
koppeln, kann sie schneller geöffnet werden. Alle 
fehlenden Elemente bleiben dann jedoch offline 
und stehen nicht zum Abspielen zur Verfügung. 
Siehe „Relink-Fenster“ auf Seite 314.

Erzwingen einer erneuten Kopplung

Wenn Sie die ursprüngliche Datei nicht erneut 
koppeln können, können Sie ein Relinking zu einer 
anderen Datei erzwingen. Siehe „Erzwingen der 
Neukopplung von Dateien“ auf Seite 317. 

Transfer-Dateien
Im Unterschied zu fehlenden Dateien werden 
Transfer-Dateien vom Programm gefunden, 
sind jedoch auf Volumes gespeichert, die sich 
nicht zur Wiedergabe eignen (etwa auf CD-ROMs 
oder Netzlaufwerken). Diese Volumes werden 
im Arbeitsbereich-Browser als Transfer-Volumes 
angezeigt. 

Öffnen einer Session mit 
Transfer-Dateien
Wenn eine Session Dateien auf einem Volume findet, 
das nicht für die Wiedergabe geeignet ist, werden 
Sie in einem Dialogfeld aufgefordert, die Dateien 
auf ein geeignetes Volume zu kopieren. 

Zum Kopieren von Transfer-Dateien, die beim 
Öffnen einer Session gefunden werden, wählen 
Sie eine der folgenden Methoden: 

 Klicken Sie auf Yes, um das Copy and Relink-
Dialogfeld zu öffnen.

 Klicken Sie auf No, um die Session zu öffnen 
und die Transfer-Dateien im Offline-Status zu 
belassen. Im Workspace-Browser der Session 
sind Transfer-Dateien durch ein „T“ in der 
Statusspalte gekennzeichnet.

Transfer-Dateien in einer 
geöffneten Session

So können Sie Transfer-Dateien in der aktuellen 
Session wiedergeben:

1 Wählen Sie die aktuelle Session im 
Locations-Bereich.

2 Doppelklicken Sie auf den Audio Files-Ordner, 
um alle Audiodateien anzuzeigen.

3 Wählen Sie im Browser-Menü Select Transfer 

Files. 

4 Wählen Sie im Browser-Menü Copy and 

Relink. 

5 Geben Sie für die kopierten Dateien einen 
Speicherort auf einem gültigen Performance-
Volume an und klicken Sie auf OK. 

6 Wiederholen Sie den Vorgang je nach Bedarf 
für Videodateien. 

Kopieren und neu koppeln 
Der Copy and Relink-Befehl ist eine 
Dateiverwaltungsoption für Sessions und Kataloge 
im Workspace-Browser. 

Dieser Befehl ermöglicht es, Dateien zu kopieren 
und die Session oder den Katalog mit den 
Dateikopien (statt mit den ursprünglichen Dateien) 
zu koppeln. 
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So werden Elemente an eine neue Position kopiert 
und gekoppelt:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Window > New Workspace 
und wählen Sie die aktuelle Session 
im Locations-Bereich.

• Öffnen Sie einen Katalog.

2 Wählen Sie die Elemente aus, die Sie kopieren 
und erneut koppeln möchten. Sie können 
beliebige Mediendateien (online, offline und 
Transfer-Dateien) auswählen. 

3 Wählen Sie im Browser-Menü Copy and Relink 

Selected. 

4 Wenn der Standardpfad für die Kopien (der 
Audio File-Ordner der Session) nicht geeignet 
ist, geben Sie einen anderen Speicherort ein und 
klicken Sie auf Choose. 

5 Die Dateien werden in den gewählten Ordner 
kopiert und die Session oder der Katalog wird 
im Hintergrund gekoppelt. 

Fehlende Dateien
Dateien werden als fehlend gemeldet, wenn sie sich 
nicht mehr an dem Ort befinden, an dem sie zuletzt 
gespeichert wurden. Möglicherweise haben Sie die 
Dateien bzw. den Session-Ordner verschoben oder 
die Dateien befinden sich auf einem Volume, das 
zurzeit nicht bereitgestellt ist. 

Öffnen einer Session mit 
fehlenden Dateien

So öffnen Sie eine Session mit fehlenden Dateien:

1 Pro Tools öffnet eine Session zusammen mit 
allen verfügbaren Medien. Wenn Dateien nicht 
gefunden werden, zeigt das Programm eine 
Warnmeldung mit der Anzahl der fehlenden 
Dateien an. Zum Fortsetzen des Vorgangs haben 
Sie verschiedene Möglichkeiten. (Wenn Sie die 
Meldung erhalten, dass Dateien nicht zur 
Wiedergabe geeignet sind, finden Sie weitere 
Informationen unter „Transfer-Dateien“ auf 
Seite 311.)

2 Wählen Sie eine der folgenden Optionen:

• Skip All – oder drücken Sie Befehl + S (Mac) 
bzw. Strg + S (Windows).

• Manually Find Relink – oder drücken Sie 
Befehl + M (Mac) bzw. Strg + M (Windows).

• Automatically Find Relink – oder drücken Sie 
Befehl + A (Mac) bzw. Strg + A (Windows).

3 Wählen Sie Regenerate Missing Rendered 

Files Without Searching, wenn gerenderte 
Elastic Audio-Dateien nicht erneut gekoppelt, 
sondern neu erstellt werden sollen.

4 Klicken Sie auf OK.
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Skip All

Mit der Skip All-Option können alle fehlenden 
Dateien übersprungen werden. Dadurch wird das 
Öffnen der Session mit allen verfügbaren Medien 
beschleunigt. Fehlende Dateien werden in der 
Session als Offline-Medien angezeigt und sind in 
der Clipliste und dem Workspace-Browser durch 
kursive Schrift gekennzeichnet. 

Manually Find and Relink

Mit dieser Option wird das Relink-Fenster geöffnet. 
Im Relink-Fenster können Sie suchen, vergleichen, 
überprüfen und Dateien erneut koppeln. Dateien 
können einzeln oder gruppenweise gekoppelt 
werden. Weitere Hinweise finden Sie unter „Relink-
Fenster“ auf Seite 314. 

Automatically Find and Relink

Automatically Find and Relink ist die einfachste 
Methode, um Sessions mit den benötigten Medien 
erneut zu koppeln. Es besteht jedoch keine 
Möglichkeit, Dateien zu vergleichen oder Kopplungen 
zu überprüfen. Dieser Vorgang kann nicht wieder 
rückgängig gemacht werden. Die Automatically Find 

and Relink-Option bewirkt Folgendes: 

• Durchsuchen aller Performance-Volumes nach 
Elementen, deren Name, ID, Format und Länge 
dem fehlenden Element entsprechen

• Koppeln fehlender Elemente mit der ersten 
gefundenen Übereinstimmung

• Bestätigen der Kopplung für alle Elemente, 
bei denen dies möglich ist

Wenn Dateien nicht gekoppelt werden können, 
wird im Tasks-Fensterbereich für angehaltene 
Vorgänge ein fehlgeschlagener Vorgang gemeldet. 
Doppelklicken Sie auf das Task-Symbol, um das 
Relink-Fenster zu öffnen und Dateien manuell zu 
suchen und zu koppeln.

Regenerate Missing Rendered Files Without 
Searching

Aktivieren Sie diese Option, um gerenderte Elastic 
Audio-Dateien beim Relinking auszuschließen 
(die gerenderten Dateien werden stattdessen 
neu berechnet). Diese Option steht zur Verfügung, 
wenn Automatically Find and Relink oder Manually 

Find and Relink aktiviert sind. 

Nach der Bestätigung sind Elemente endgültig 
gekoppelt. Dieser Vorgang kann nicht wieder 
rückgängig gemacht werden, sobald die 
Session gespeichert ist. Sie haben lediglich die 
Möglichkeit, die Session ohne Speichern der 
Änderungen zu schließen. 

Auch wenn alle fehlenden Dateien später 
gefunden und gekoppelt werden, wird diese 
Fehlermeldung weiterhin im Tasks-Fenster 
angezeigt. Alle fehlgeschlagenen Vorgänge 
müssen manuell ausgewählt und gelöscht 
werden. Siehe „Allgemeines zu 
fehlgeschlagenen Vorgängen“ auf Seite 323. 
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Relink-Fenster
Im Relink-Fenster haben Sie Zugriff auf alle Kopplungsfunktionen. 

Menü und Symbolleiste – umfassen das Relink-
Menü sowie die Schaltflächen für 
Anzeigevoreinstellungen und Kopplung. Der 
Status wird im rechten Bereich angezeigt.

Areas to Search (Suchbereiche) – dienen der 
Auswahl von Volumes, die nach fehlenden 
Elementen durchsucht werden sollen. 

Files to Relink – hier werden fehlende 
Dateien aufgelistet.

Candidates – hier werden die Dateien aufgelistet, 
die mit den Kopplungskriterien für eine bestimmte 
fehlende Datei übereinstimmen. 
Das Kopplungssymbol neben einer möglichen 
Entsprechung (Candidate) kann ein- oder 
ausgeblendet werden, um eine Kopplung 
zur fehlenden Datei zu erstellen. 

Das Relink-Fenster steuert den gesamten 
Kopplungsvorgang. 

Öffnen des Relink-Fensters
Wenn beim Öffnen der Session Dateien fehlen, 
wählen Sie Manually Find and Relink und öffnen 
Sie das Relink-Fenster. 

Auf das Relink-Fenster besteht auch nach Öffnen 
einer Session Zugriff. 

So greifen Sie in einer geöffneten Session auf das 
Relink-Fenster zu:

1 Wählen Sie im Workspace-Browser die 
Elemente aus, die Sie verkoppeln möchten. 

2 Wählen Sie im Browser-Menü Relink Offline. 

Hauptelemente des Relink-Fensters

Files to Relink

Candidates

Areas to Search

Menü und 
Symbolleiste
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Auswählen der Suchbereiche
Durch Auswahl der Volumes und Ordner im Areas 
to Search-Fensterbereich können Sie die Suche 
nach fehlenden Dateien einschränken. Dies kann 
das Koppeln von Dateien beschleunigen, da eine 
kleinere Zahl von Volumes oder Ordnern 
durchsucht werden muss. Außerdem können 
bei mehreren Versionen desselben Elements 
die weniger geeigneten Versionen von der 
Suche ausgeschlossen werden.

So wählen Sie Volumes oder Ordner für die Suche 
aus:

1 Konfigurieren Sie den Areas to Search-Bereich, 
sodass die zu durchsuchenden Volumes, Kataloge 
oder Ordner angezeigt werden. 

2 Klicken Sie auf die Suchspalte neben dem 
gewünschten Element, damit es bei der Suche 
berücksichtigt bzw. von der Suche 
ausgeschlossen wird. Ein Häkchen zeigt an, 
dass das Element bei der Suche berücksichtigt 
wird. Alle Ordner innerhalb der Elemente 
werden ebenfalls durchsucht.

Koppeln einzelner und mehrerer 
Dateien
Im Relink-Fenster können fehlende Dateien einzeln 
oder gruppenweise erneut gekoppelt werden. 

Koppeln von einzelnen fehlenden Dateien

In bestimmten Fällen müssen fehlende Dateien 
einzeln (nacheinander) mit der Session gekoppelt 
werden. Dies ist beispielsweise erforderlich, wenn 
mehrere Kopien einer Mediendatei online zur 
Verfügung stehen oder wenn Sie den 
Kopplungsvorgang sehr präzise und flexibel 
steuern möchten. 

So koppeln Sie eine fehlende Datei:

1 Konfigurieren Sie den Areas to Search-Bereich. 

2 Wählen Sie ein Element in der Files to Relink-
Liste. 

3 Klicken Sie auf Find All Candidates. 

Für die Suche ausgewählte Volumes

„Find All Candidates“ für das Relinking einer 
ausgewählten fehlenden Datei
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Pro Tools durchsucht die ausgewählten Volumes und 
zeigt alle Dateien mit übereinstimmendem 
Dateinamen oder eindeutiger ID in der Candidates-
Liste an. Kopplungssymbole zeigen, ob ein Element 
in der Candidates-Liste bereits gekoppelt ist.

4 Klicken Sie auf das Steuerelement neben der 
Datei, die Sie koppeln möchten. 
Ein Kopplungssymbol zeigt an, dass die Datei 
mit dem derzeit in der Files to Relink-Liste 
ausgewählten Element gekoppelt wird.

5 Wenn Sie weitere fehlende Dateien erneut 
koppeln möchten, klicken Sie auf das 
Kopplungssymbol neben der gewünschten Datei.

6 Klicken Sie auf Commit Links.

Erneutes Koppeln von mehreren 
fehlenden Dateien 

Mit der Find Links-Schaltfläche können mehrere 
Dateien in einem Arbeitsschritt gesucht 
und gekoppelt werden. 

So koppeln Sie mehrere fehlende Dateien:

1 Konfigurieren Sie „Areas to Search“ (Siehe 
„Auswählen der Suchbereiche“ auf Seite 315.)

2 Wählen Sie mindestens ein Element in der Files 
to Relink-Liste aus. Die Find Links-
Schaltfläche wird verfügbar. 

3 Klicken Sie auf Find Links. 

4 Konfigurieren Sie ggf. die Kriterien, die zum 
Koppeln verwendet werden sollen, im Linking 
Options-Dialogfeld:

• Standardmäßig sind die Optionen „Find 
by Name“ und „Find by ID“ aktiviert.

• Zusätzliche Kriterien können im Linking 
Options-Dialogfeld ausgewählt werden. 
(„Match Modification Date“ kann nur bei 
Katalogen verwendet werden.)

• Wenn Match Duration aktiviert ist, wählt Pro Tools 
Dateien derselben Länge oder länger. 

5 Klicken Sie zum Fortsetzen des Vorgangs auf 
OK (oder klicken Sie auf Cancel, um zum 
Relink-Fenster zurückzukehren). 

OMF-Videoclips können mit einer Session 
nur erneut gekoppelt werden, wenn sie 
entsprechende eindeutige IDs aufweisen.

QuickTime-Videoclips können nur anhand von 
Dateinamen und Dateiformat (QuickTime) 
erneut mit einer Session gekoppelt werden.

Um die Kriterien festzulegen, die beim Koppeln 
einer fehlenden Datei verwendet werden, 
klicken Sie auf „Find Links“. Die Funktion 
„Find Links“ wird unter „Erneutes Koppeln 
von mehreren fehlenden Dateien“ auf 
Seite 316 erläutert.

Kopplungssymbol zum Kennzeichnen 
des Kopplungsstatus

Kopplungsoptionen
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Pro Tools sucht nach einer möglichen 
Entsprechung für die erste fehlende Datei 
(das erste ausgewählte Element in der Files to 
Relink-Liste). Das Programm findet und koppelt 
die fehlende Datei mit der ersten gefundenen 
Entsprechung. Ein Kopplungssymbol wird 
eingeblendet, sobald die Dateien gekoppelt sind. 
Die Link Path-Spalte zeigt den Speicherort der 
ausgewählten Entsprechung an. Pro Tools setzt 
den Vorgang fort, bis alle fehlenden Dateien in der 
Files to Relink-Liste gekoppelt sind. 

6 Um eine Entsprechung für eine fehlende Datei 
anzuzeigen, markieren Sie die Datei. 
Die Entsprechung zu dieser Datei wird in der 
Candidates-Liste angezeigt. Dort können Sie die 
Dateiinformationen und Wellenform überprüfen.

7 Wenn Sie mit der Entsprechung einer bestimmten 
fehlenden Datei nicht einverstanden sind, wählen 
Sie Find All Candidates für die betreffende Datei 
(siehe „Koppeln von einzelnen fehlenden Dateien“ 
auf Seite 315). 

Erzwingen der Neukopplung 
von Dateien
Wenn Sie eine Kopplung zu einer Ersatzdatei 
herstellen möchten (wenn Sie beispielsweise 
wissen, dass eine Datei dieselben Audio- oder 
Videodaten enthält, jedoch der Dateiname oder die 
ID nicht übereinstimmt), können Sie eine 
Neukopplung erzwingen.

 Damit Sie eine Neukopplung mit einer Audiodatei 
erzwingen können, müssen das Dateiformat (WAV, 
AIFF oder MXF), die Samplerate und die Bitrate mit 
der der ursprünglichen Datei übereinstimmen.

 Damit Sie eine Neukopplung mit einer Videodatei 
erzwingen können, müssen das Dateiformat 
(QuickTime, Avid, MXF oder OMF) und die 
Framerate mit der der ursprünglichen Datei 
übereinstimmen.

So erzwingen Sie eine Neukopplung:

1 Wählen Sie die Elemente aus, die Sie neu 
koppeln möchten. 

2 Wählen Sie im Browser-Menü Relink Offline. 

3 Wählen Sie im Relink-Fenster ein Element in 
der Files to Relink-Liste. 

4 Navigieren Sie im Areas to Search-
Fensterbereich zu der Datei, für die Sie eine 
Neukopplung herstellen möchten.

5 Ziehen Sie die Datei in den Candidates-Bereich 
des Relink-Fensters.

6 Klicken Sie auf das Steuerelement neben der 
Datei, die Sie in den Candidates-Fensterbereich 
gezogen haben. 

7 Klicken Sie auf Commit Links.

Bestätigen von Kopplungen
Dieser Vorgang kann nicht wieder rückgängig 
gemacht werden. Wenn eine Datei erneut 
gekoppelt und die Session gespeichert wurde, gilt 
die neue Kopplung (die ursprüngliche Kopplung 
wird „vergessen“.) Deshalb werden die Dateien 
erst gekoppelt, wenn die Kopplung mit Commit 

Links bestätigt wurde. 

So bestätigen Sie Kopplungen:

1 Koppeln Sie Dateien im Relink-Fenster wie 
unter „Koppeln einzelner und mehrerer 
Dateien“ auf Seite 315 erläutert. 

Die Automatically Find and Relink-Option ist 
der einzige Relinking-Vorgang, bei dem Sie 
nicht zur Überprüfung der Kopplungen 
aufgefordert werden. Wenn Sie diese Option 
verwenden und die Ergebnisse nicht Ihren 
Erwartungen entsprechen, schließen Sie die 
Session, ohne sie zu speichern, damit die neu 
vorgenommenen Kopplungen nicht 
übernommen werden. 
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2 Klicken Sie auf Commit. Sie werden zur 
Bestätigung des Vorgangs aufgefordert. 

3 Sie haben folgende Möglichkeiten:

• Klicken Sie zum Bestätigen auf Yes. 

• Klicken Sie auf No zum Abbrechen des Vorgangs. 

Neukopplung und Aliase 
in Katalogen
Kataloge bestehen aus „Aliasen“ oder 
„Verknüpfungen“ zu tatsächlichen Dateien. Wenn 
die Dateien verschoben werden, müssen sie erneut 
mit den Katalogelementen gekoppelt werden. 

So koppeln Sie einen Katalog erneut:

1 Öffnen Sie den Katalog. 

2 Wählen Sie die Elemente aus, die erneut 
gekoppelt werden sollen. 

3 Wählen Sie im Browser-Menü des entsprechenden 
Katalog-Fensters Relink Selected.

Kataloge
Kataloge sind mit einem Favoriten-Ordner 
vergleichbar, in dem häufig verwendete 
Elemente unabhängig von ihrem Speicherort 
zusammengestellt werden. Ein Katalog ist im Prinzip 
ein Ordner mit Aliasen oder Verknüpfungen. Wenn 
eine Datei in einem Katalog platziert wird, wird sie 
selbst weder kopiert noch verschoben. Stattdessen 
wird eine Referenz (ein Alias) zu dieser Datei 
angelegt, sodass der Benutzer ohne langes Suchen auf 
sie zugreifen und sie modifizieren kann. 

Erstellen von Katalogen
Sie können neue, leere Kataloge im Arbeitsbereich 
hinzufügen oder zuerst Elemente auswählen und 
diese anschließend in einem Katalog speichern. 

So erstellen Sie einen neuen, leeren Katalog:

1 Öffnen Sie einen Workspace-Browser. 

2 Wählen Sie im Browser-Menü New Catalog. 

3 Geben Sie einen eindeutigen Namen ein und 
klicken Sie auf OK. 

So katalogisieren Sie eine Auswahl von Elementen: 

1 Öffnen Sie einen Workspace-Browser. 

2 Wählen Sie die Elemente für den neuen Katalog. 

3 Wählen Sie im Browser-Menü Create Catalog 

from Selection. 

Eine neue, vollständig indizierte Katalogdatenbank 
mit den ausgewählten Elementen wird erstellt. 

Erstellen von Katalogen aus Ordnern

So erstellen Sie einen Katalog aus einem Ordner 
und seinem Inhalt: 

1 Öffnen Sie den Arbeitsbereich-Browser. 

2 Ziehen Sie einen einzelnen Ordner auf das 
Katalogsymbol im Arbeitsbereich-Browser und 
legen Sie ihn ab. 

Pro Tools indiziert die Ordner zunächst und 
erstellt dann einen vollständig indizierten Katalog 
mit dem Namen des abgelegten Ordners.

Umbenennen eines Katalogs
Kataloge können jederzeit umbenannt werden. 

So benennen Sie einen Katalog um:

1 Markieren Sie das Katalogelement im 
Arbeitsbereich-Browser. 

2 Geben Sie einen neuen Katalognamen ein. 

Ändern von Katalogen

Sie haben folgende Möglichkeiten, um einem 
Katalog Elemente hinzuzufügen:

 Öffnen Sie den Katalog und ziehen Sie neue 
Elemente aus einem anderen Workspace-
Browser hinein. 
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 Klicken Sie im Arbeitsbereich auf das 
Hauptsymbol für Kataloge, um alle vorhandenen 
Kataloge anzuzeigen. Legen Sie die neuen 
Elemente in einem beliebigen Katalog ab. 

So fügen Sie einem Katalog einen Ordner hinzu:

1 Öffnen Sie den Katalog.

2 Wählen Sie im Browser-Menü New Folder. 

Entfernen von Katalogelementen
Beim Entfernen eines Ordners oder einer Datei aus 
einem Katalog können Sie in Pro Tools 
entscheiden, ob nur das Alias aus dem Katalog 
oder die Originaldateien selbst von der Festplatte 
gelöscht werden sollen. 

So löschen Sie ein Element aus einem Katalog: 

1 Wählen Sie im Locations-Bereich einen 
Katalog aus.

2 Wählen Sie im Browser-Bereich mindestens ein 
Element des Katalogs zum Entfernen aus.

3 Wählen Sie im Browser-Menü Remove 
Selected Items.

4 Nach Anzeige einer entsprechenden 
Aufforderung haben Sie folgende Möglichkeiten: 

• Klicken Sie auf Remove, um die Aliase der 
ausgewählten Elemente im Katalog zu entfernen. 

• Klicken Sie auf Move To Trash (Mac) oder Move To 

Recycle Bin (Windows), um die ausgewählten 
Elemente von der Festplatte (und die zugehörigen 
Aliase aus dem Katalog) zu entfernen.

Konsolidieren von Dateien 
mit Katalogen
Kataloge sind nützlich, um Dateien aus 
verschiedensten Quellen zu konsolidieren. 

Erstellen Sie etwa einen Katalog mit dem Namen 
„Donner“ und füllen Sie ihn mit Soundeffekten von 
drei verschiedenen Volumes. Sie können den 
Katalog aus dem Arbeitsbereich-Browser auf ein 

anderes Volume ziehen. Der Ordner „Donner“ wird 
auf diesem Volume erstellt. Alle Dateien, auf die sich 
der Katalog bezieht, werden automatisch auf das 
Volume kopiert. Ordner und Unterordner sowie 
deren Inhalt werden dabei ebenfalls kopiert. 

Aktualisieren von Katalogen
Da eine Katalogdatenbank nicht an ein bestimmtes 
Volume gekoppelt ist, sind die Möglichkeiten des 
Update Index-Befehls beschränkt. Wenn im 
Browser-Menü eines Katalogs Update Index for 

Selected Items ausgewählt wurde, sucht Pro Tools 
nach den Elementen, die den Aliasen im Katalog 
entsprechen, und aktualisiert folgende 
Informationen:

Metadaten – aller gefundenen Online-Dateien 
(einschließlich Dateianmerkungen) werden 
aktualisiert.

Datenbankanmerkungen – werden nicht 
aktualisiert, da sie zum Katalog und nicht zu den 
Metadaten der Datei gehören.

Koppeln von Katalogelementen
Wenn Dateien in einem Katalog fehlen, suchen, 
kopieren und koppeln Sie sie über das Relink-
Fenster. Weitere Informationen finden Sie unter 
„Koppeln und Neukoppeln von Dateien“ auf 
Seite 310. 

Entfernen von Katalogen

So löschen Sie einen Katalog:

1 Wählen Sie im Locations-Bereich einen 
Katalog aus.

2 Wählen Sie den Katalog im Browser-Bereich.

3 Wählen Sie im Browser-Menü Remove Selected 

Items. Eine Warnmeldung wird angezeigt.
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4 Im Dialogfeld der Warnmeldung haben Sie 
folgende Möglichkeiten:

• Klicken Sie auf Cancel, um den 
Vorgang abzubrechen.

• Klicken Sie auf Move to Trash (Mac) oder Move 

to Recycle Bin (Windows), um Aliasnamen 
und entsprechende Dateien von der Festplatte zu 
entfernen.

• Klicken Sie auf Remove, um nur die Aliase 
aus dem Katalog (und nicht die zugeordneten 
Dateien von der Festplatte) zu entfernen.

Dieser Vorgang kann nicht wieder rückgängig 
gemacht werden. 

Importieren von 
Katalogelementen
Sie können Online- und Offline-Elemente aus dem 
Katalog in die aktuelle Session importieren. 

Importieren von Online-Elementen 
aus einem Katalog

Ähnlich wie in Workspace-Browsern können 
Audiodateien in die Pro Tools-Clipliste und 
Timeline gezogen und dort abgelegt werden. 

Importieren von Offline-Elementen aus 
einem Katalog

Mithilfe von Katalogen können Sie Offline-Dateien 
suchen und importieren. Wenn Sie etwa ein Musik-
Cue verwenden möchten, das sich auf einer anderen 
CD-ROM oder einem nicht bereitgestellten Volume 
befindet, können Sie die im Katalog angezeigte Datei 
auf der Timeline der Session positionieren. Sie wird 
beim Bereitstellen des Volume automatisch in die 
Session importiert. 

Zuerst müssen dem Katalog Dateien hinzugefügt 
werden. (Die Dateien müssen dazu online zur 
Verfügung stehen.) Wenn Katalogelemente nicht 
mehr online verfügbar sind, werden sie in kursiver 
Schrift angezeigt. 

Die in einem Katalog aufgeführten Offline-
Dateien können wie Online-Dateien auf der 
Timeline abgelegt werden. Nach dem Ablegen der 
Dateien wird ein Dialogfeld angezeigt, über das 
Sie die Dateien erneut koppeln können. Klicken 
Sie auf Skip All, um die Elemente als Offline-
Dateien zu laden. In der Timeline werden die 
entsprechenden Clips dann in Hellblau angezeigt. 

Sobald das Volume bereitgestellt wird, auf dem 
die Offline-Elemente gespeichert sind, werden die 
Dateien von Pro Tools automatisch im 
Hintergrund importiert. Das geschieht auch, wenn 
Sie die Session inzwischen gespeichert, Pro Tools 
verlassen und neu gestartet haben. 

Nach dem Importieren werden die Elemente in der 
Timeline, der Clipliste und im Workspace-
Browser als Online-Elemente angezeigt. 

Entsprechen Samplerate, Bitrate und Dateiformat 
der Offline-Elemente denen der Session, ist keine 
Konvertierung erforderlich. Die Elemente können 
in der Session abgespielt werden, sofern das 
Volume zur Wiedergabe geeignet und 
bereitgestellt ist. 

Ist das nicht der Fall, wird eine Meldung angezeigt 
und die Elemente müssen auf ein anderes Volume 
kopiert werden. 

Weitere Informationen finden Sie unter 
„Importieren von Dateien per Drag & 
Drop“ auf Seite 329. 

Weitere Informationen zu Transfer-Dateien, 
fehlenden Dateien und zum Koppeln finden 
Sie unter „Relink-Fenster“ auf Seite 314.
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Task Manager-Fenster
Das Task Manager-Fenster von Pro Tools bietet Funktionen für eine flexible und leistungsstarke 
Dateiverwaltung. Die Dateiverwaltung von Pro Tools befasst sich mit dem Erstellen, Kopieren, 
Konvertieren, Verarbeiten, Suchen und Indizieren von Dateien – alles Aufgaben, die fast andauernd 
anfallen. Diese Dateiverwaltungsvorgänge werden im Hintergrund ausgeführt. Arbeitsschritte wie 
das Aufnehmen, Editieren und Mischen müssen dazu nicht unterbrochen werden. 

Im Tasks-Fenster können Sie laufende Vorgänge (einschließlich Kopieren, Fade-Regenerierung 
und Indizieren) überwachen, anhalten und abbrechen. 

Öffnen des Tasks-Fensters

So öffnen Sie das Tasks-Fenster:

 Wählen Sie in Pro Tools die Optionen 
Window > Task Manager.

Meldungen im Tasks-Fenster
Wenn Hintergrundvorgänge nicht erfolgreich 
ausgeführt werden können, wird das Tasks-Fenster 
mit einer entsprechenden Meldung 
im Vordergrund eingeblendet. Der unvollständig 
ausgeführte Vorgang wird im Fensterbereich 
für angehaltene Vorgänge angezeigt. 

Da das Tasks-Fenster frei beweglich ist, wird der 
in Ausführung begriffene Arbeitsschritt nicht 
unterbrochen. Sie können also weiter aufnehmen 
oder editieren und die Dateiverwaltung auf später 
verschieben.

Tasks-Fenster (maximierte Ansicht)

Angehaltene 

Vorgänge

Aktive Vorgänge

Schaltfläche zum Wechseln der Ansicht (Maximieren/Minimieren)

Status

Drücken Sie Wahl + ' (Mac) bzw. 
Alt + ' (Windows), um den Arbeitsbereich-
Browser zu öffnen.
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Tasks-Fenster-Ansichten
Das Tasks-Fenster kann maximiert und minimiert 
werden.

So wechseln Sie zwischen der maximierten 
und minimierten Ansicht:

 Klicken Sie oben im Tasks-Fenster auf 
die Schaltfläche zum Wechseln der Ansicht. 

Funktionen, Spalten und 
Ansichten im Tasks-Fenster
Das Tasks-Fenster-Menü enthält Befehle für 
Vorgänge, die im Tasks-Fenster ausgeführt 
werden sollen.

Folgende Daten werden stets im Tasks-Fenster 
(beide Ansichten) angezeigt:

Name – gibt den Namen des entsprechenden 
Elements an (Datei, Datenbank oder ein anderes 
unterstütztes Element).

Status – gibt den ausgeführten Vorgang 
(etwa Kopieren, Verarbeiten, Indizieren usw.) an.

Fortschritt – zeigt den Verlauf eines Vorgangs bzw. 
der untergeordneten Vorgänge, einschließlich 
der Elementgröße und einer Angabe über 
die geschätzte Zeit bis zum Abschluss. 

Verlaufsanzeige – zeigt an, dass ein Vorgang läuft. 

Prozentangabe – zeigt den Status des aktuellen 
Vorgangs in Prozent an.

Fensterbereich für aktive Vorgänge

Der Fensterbereich für aktive Vorgänge (oben) zeigt 
die Vorgänge an, die gerade ausgeführt bzw. darauf 
warten, ausgeführt zu werden. Der derzeit 
ausgeführte Vorgang steht an oberster Stelle 
der Liste. Die Vorgänge in diesem Fensterbereich 
werden der Reihe nach abgearbeitet. 

Sobald ein Vorgang abgeschlossen ist, wird er aus 
der Warteliste gelöscht.

Vorgänge, die nicht erfolgreich ausgeführt werden 
können, werden in den Fensterbereich für 
angehaltene Vorgänge verschoben. Die Status-Spalte 
zeigt eine Beschreibung des Fehlers an.

Fensterbereich für angehaltene 
Vorgänge

Der Fensterbereich für angehaltene Vorgänge wird 
unter dem Fensterbereich für aktive Vorgänge 
angezeigt. Zwischen den Bereichen befindet sich eine 
verschiebbare horizontale Trennlinie. Vorgänge in 
diesem Fensterbereich werden erst ausgeführt, wenn 
sie wieder in den aktiven Fensterbereich verschoben 
werden. 

Anhalten und Abbrechen 
von Vorgängen
Im Tasks-Fenster können Vorgänge angehalten, 
wieder aufgenommen und abgebrochen werden. 

So halten Sie einen Vorgang an:

 Ziehen Sie den gewünschten Vorgang aus 
dem Fensterbereich für aktive Vorgänge in den 
Fensterbereich für angehaltene Vorgänge. 

So halten Sie alle Vorgänge an:

 Wählen Sie im Tasks-Fenster-Menü Pause All.

Tasks-Fenster (minimierte Ansicht)
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So nehmen Sie einen Vorgang wieder auf:

 Ziehen Sie den gewünschten Vorgang aus dem 
Fensterbereich für aktive Vorgänge in den 
Fensterbereich für angehaltene Vorgänge. 
Der Vorgang wird an seine vorherige Position in 
der Warteliste verschoben. 

So nehmen Sie alle angehaltenen Vorgänge 
wieder auf:

 Wählen Sie im Tasks-Fenster-Menü Resume 

All. Alle Vorgänge im Fensterbereich für 
angehaltene Vorgänge (ausgenommen 
fehlgeschlagene Vorgänge) werden im 
Fensterbereich für aktive Vorgänge eingefügt. 

So brechen Sie einen Vorgang ab:

1 Markieren Sie einen Vorgang in einem Tasks-
Fensterbereich.

2 Drücken Sie auf die Entf-Taste, um den 
Vorgang aus dem Tasks-Fenster zu entfernen. 

So brechen Sie alle Vorgänge ab:

1 Wählen Sie einen Vorgang in einem 
Fensterbereich. 

2 Drücken Sie Befehl + A (Mac) bzw. 
Strg + A (Windows), um alle Vorgänge 
in diesem Fensterbereich auszuwählen.

3 Drücken Sie die Entf-Taste.

Dieser Befehl kann nicht rückgängig 
gemacht werden.

Allgemeines zum Abbrechen von 
Vorgängen

Manche Vorgänge bestehen aus einem oder 
mehreren untergeordneten Vorgängen. Durch das 
Löschen eines Vorgangs können bereits 
ausgeführte untergeordnete Vorgänge nicht 
rückgängig gemacht werden. Wenn das 
Importieren und Konvertieren mehrerer Dateien 
als ein einziger Vorgang angezeigt wird und 

Sie diesen löschen, bevor er abgeschlossen ist, 
brechen Sie dadurch den Import und die 
Konvertierung weiterer Dateien ab. Die bereits 
konvertierten und importierten Dateien bleiben 
jedoch auf dem Volume. Wenn Sie einen aus 
mehreren untergeordneten Vorgängen 
bestehenden Vorgang abbrechen möchten, sollten 
Sie den gesamten Vorgang zunächst abschließen 
und dann mit dem Undo-Befehl alle 
untergeordneten Vorgänge rückgängig machen. 

Schließen einer Session mit 
ausstehenden Vorgängen
Wenn beim Schließen einer Session oder Verlassen 
von Pro Tools einige der aktiven oder angehaltenen 
Vorgänge noch ausstehen, werden Sie in einer 
Meldung aufgefordert, diese entweder abzubrechen 
oder auszuführen. Sie können dann das Tasks-
Fenster öffnen und warten, bis die ausstehenden 
Vorgänge abgeschlossen sind, die ausstehenden 
Vorgänge abbrechen oder das Programm verlassen. 
Wenn Sie das Programm verlassen, werden einige 
Vorgänge abgebrochen. Vorgänge, bei denen 
Dateien kopiert werden, bleiben „vorgemerkt“ und 
werden beim nächsten Öffnen von Pro Tools erneut 
gestartet. 

Allgemeines zu fehlgeschlagenen 
Vorgängen

Der Fensterbereich für angehaltene Vorgänge 
zeigt alle Vorgänge, die nicht bis zu Ende 
ausgeführt werden konnten. Die Spalte „Status“ 
zeigt eine Beschreibung des Fehlers an. 

Fehlgeschlagene Vorgänge können nicht 
wieder aufgenommen werden und müssen 
im Fensterbereich für angehaltene Vorgänge 
manuell gelöscht werden. 
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Wenn mit Automatically Find and Relink nicht alle 
Dateien für eine Session gefunden werden konnten, 
wird im Tasks-Fensterbereich für angehaltene 
Vorgänge ein fehlgeschlagener Vorgang angezeigt. 
Diese Meldung muss manuell aus dem Tasks-Fenster 
entfernt werden (auch wenn Sie die Dateien später 
gefunden und erneut gekoppelt haben). 

Festlegen von Prioritäten
Ein laufender Vorgang kann durch einen Vorgang mit 
höherer Priorität unterbrochen werden. Dabei werden 
teilweise abgeschlossene Vorgänge angehalten und 
später weiter bearbeitet. Sie werden mit einer 
Verlaufsanzeige im Fensterbereich für aktive 
Vorgänge angezeigt. Wenn der Vorgang mit der 
höheren Priorität abgeschlossen ist, wird mit der 
Verarbeitung des ersten unvollständigen Vorgangs in 
der Warteschlange begonnen.

Anhalten eines Vorgangs 
während der Wiedergabe 
Das Browser-Menü des Tasks-Fensters enthält die 
allgemeine Voreinstellung Pause during Playback. 
Bei Auswahl dieser Einstellung werden aktive 
Vorgänge bei der Wiedergabe (bzw. Aufnahme) in 
Pro Tools angehalten. Diese Einstellung ist 
besonders nützlich, wenn Sie mit einem 
langsameren Prozessor arbeiten oder Ihr System 
zugunsten einer optimalen Wiedergabe- 
und Aufnahmeleistung entlasten möchten. 
Die Auswahl dieser Einstellung wird bis zur 
nächsten Änderung gespeichert. 

Gespeicherte Vorgänge
Jeder Vorgang, bei dem Dateien in eine Session 
importiert werden, wird beim Schließen der 
Session gespeichert und beim nächsten Öffnen der 
Session wieder aufgenommen. Wenn Sie 
etwa Session-Daten importieren und dazu die 
Copy From Source Media-Option aktivieren, dann 

die Session speichern und vor Abschluss des 
Kopiervorgangs das Programm schließen, werden 
die Kopiervorgänge beim nächsten Öffnen der 
Session wieder aufgenommen. 

Gruppierte Vorgänge
Gewisse Vorgänge setzen sich aus einer Reihe 
untergeordneter Vorgänge zusammen. Beim Copy 

and Relink-Vorgang werden möglicherweise 
Hunderte von Einzeldateien kopiert und erneut 
gekoppelt. Um die Verwaltung dieser Vorgänge zu 
vereinfachen, werden sie unter dem anfänglichen 
Befehl gruppiert. Beim Copy and Relink-Befehl 
wird der Kopiervorgang im Tasks-Fenster einmal 
aufgeführt. Daneben wird ein Symbol zum 
Erweitern bzw. Reduzieren angezeigt. Wenn Sie 
darauf klicken, werden die untergeordneten 
Vorgänge angezeigt.

Enthält die Warteschlange mehrere gruppierte 
Vorgänge, müssen alle untergeordneten Vorgänge 
der ersten Gruppe abgeschlossen sein, bevor die 
untergeordneten Vorgänge der zweiten Gruppe 
verarbeitet werden können.

Wenn eine Session mit ausstehenden 
Gruppenvorgängen gespeichert und geschlossen 
wird und es sich bei den ausstehenden 
Gruppenvorgängen um Vorgänge handelt, 
die beim Schließen der Session unterbrochen und 
gespeichert werden können, dann werden alle 
diese Vorgänge beim nächsten Öffnen der Session 
in derselben Gruppe angezeigt. 
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Kapitel 17: Importieren und Exportieren 
von Session-Daten

Mit Pro Tools können Sie verschiedene Daten, 
einschließlich Audio- und MIDIn-Dateien, 
Clipgruppen, Videodateien, Spur-Playlists, I/O- 
und Signal-Routing-Konfigurationen, in eine 
Session importieren oder daraus exportieren.

Sie können einzelne Audio- und MIDI-Dateien in 
eine Session importieren oder ganze Audio- und 
MIDI-Spuren zusammen mit den entsprechenden 
Attributen aus einer anderen Session importieren. 
Mit Pro Tools HD haben Sie die Möglichkeit, 
beliebige Kombinationen von Spurattributen, 
wie etwa die Audio- oder MIDI-Playlists einer Spur, 
das Signal-Routing, Plug-Ins oder die Automation, 
aus anderen Sessions zu importieren (siehe 
„Importieren von Session-Daten“ auf Seite 346). 

Wenn Sie mit Videomaterial arbeiten, können Sie 
Videodateien in eine Session importieren und aus 
einer Session exportieren (siehe Kapitel 52: 
„Video in Pro Tools“). 

Importieren von Daten in und 
Exportieren aus einer Session
Importieren

Mit Pro Tools können Sie Audio-, Video- und 
MIDI-Daten, Clipgruppen oder Session-Dateien in 
die aktuelle Pro Tools-Session importieren. Sie 
haben dazu folgende Möglichkeiten:

• Drag & Drop über: 

• Workspace-Browser

• Mac Finder oder Windows Explorer

• Import-Befehle des File-Menüs:

• Session Data

• Audio

• MIDI

• Video

• Clip Groups

• VENUE Channel Names as Track Names

Session-Daten, Audiodateien und Clips können in 
bestehende Spuren, neue Spuren, die Tracks-Liste 
oder die Clipliste einer Pro Tools-Session 
importiert werden.

Exportieren

Mit Pro Tools können Sie Audio-, Video- und MIDI-
Daten, Clipgruppen und Session-Daten exportieren. 
Sie haben dazu folgende Möglichkeiten:

• Export to Sibelius- oder Send to Sibelius-Befehl 
(nur MIDI)

• Export-Befehle des File-Menüs:

• Selected Tracks as New AAF/OMF 

• Selected Tracks as New Session

• MIDI 

• Sibelius 

• Session Info As Text 

• Tracks-Kontextmenü:

• Send To Sibelius-Befehl (nur Score Editor)

• Export MIDI-Befehl
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• Verwendung des Clip List-Menüs:

• Export Clip Definitions-Befehl

• Export Clips as Files-Befehl

• Export Clip Groups-Befehl

Audiokonvertierung beim 
Importieren
Je nach den Eigenschaften der importierten 
Audiodateien können Sie die Dateien hinzufügen, 
kopieren oder konvertieren.

 Wenn Dateien einer Pro Tools-Session 
hinzugefügt werden, verbleiben sie am aktuellen 
Festplatten-Speicherort und werden weder 
verschoben noch kopiert. Die Session verweist auf 
die ursprünglichen Dateien unabhängig davon, wo 
sich diese auf Ihrem System befinden. Die von der 
Session referenzierten Dateien behalten zusätzlich 
ihr ursprüngliches Dateiformat, die Samplerate 
und Bitrate bei.

 Wenn Dateien in eine Session kopiert werden, 
verbleiben die ursprünglichen Dateien an ihrem 
Speicherort im System und werden in den Audio Files-
Ordner kopiert. Danach werden sie der Session 
hinzugefügt. Die Session verweist nicht auf die 
ursprünglichen Dateien, sondern auf die Kopien. 
Die kopierten, von der Session referenzierten Dateien 
behalten zusätzlich ihr ursprüngliches Dateiformat, die 
Samplerate und Bitrate bei.

 Wenn Dateien in eine Session konvertiert 
werden, verbleiben die ursprünglichen Dateien an 
ihrem Speicherort im System, werden in das 
Dateiformat, die Samplerate und Bitrate der 
Session konvertiert und in den Audiodateiordner 
der Session geschrieben. Die Session verweist 
nicht auf die ursprünglichen Dateien, sondern auf 
die konvertierten Dateien. 

Dateien, die einer Session ohne Konvertierung 
hinzugefügt werden können

Sie können alle Audiodateien, deren Dateiformat 
(WAV und AIFF) und Bitrate (16, 24 und 32-Bit-
Gleitkomma) unterstützt wird, zu Sessions 
hinzufügen, ohne sie konvertieren zu müssen. 
Audiodateien, deren Samplerates nicht mit der 
Samplerate der Session übereinstimmen, können 
ohne vorherige Konvertierung zu der Session 
hinzugefügt werden. Die Dateien werden dann 
allerdings mit einer anderen Tonhöhe (Pitch) und 
Geschwindigkeit wiedergegeben als Dateien mit 
derselben Samplerate wie die Session.

Dateien, die beim Import konvertiert werden 
müssen

Audiodateien mit anderen Formaten als WAV und 
AIFF müssen beim Import konvertiert werden. 
Pro Tools konvertiert diese Dateien beim Import 
automatisch in das aktuelle Dateiformat 
der Session. Wenn die Session nicht für 
Interleaved-Dateien aktiviert ist, teilt Pro Tools 
beim Import außerdem Interleaved-Audiodateien 
in mehrere Mono-Dateien.

Wenn in einer Audiodatei Clips definiert sind, 
können Sie ausgewählte Clips konvertieren und 
die dazugehörigen Audiodaten importieren, ohne 
die gesamte ursprüngliche Audiodatei mit dem 
Import Audio-Befehl importieren zu müssen.

Sie können die automatische Kopie von Dateien 
beim Import über die Automatically Copy Files 
on Import-Option auf der Processing 
Preferences-Seite aktivieren, um sicherzugehen, 
dass Dateien beim Importieren von Audio per 
Drag & Drop immer in den Audio Files-Ordner 
der Session kopiert werden.

Pro Tools 7.x und höher unterstützt 
Audiodateinamen, die bestimmte ASCII-
Zeichen enthalten, nicht (siehe „Öffnen einer 
Session, die Audiodateinamen mit ungültigen 
Zeichen enthält“ auf Seite 387).
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Unterstützte Audiodateiformate
Sie können die folgenden Typen von Audiodateien 
ohne Konvertierung in Pro Tools-Sessions 
importieren:

• AIFF

• WAV oder BWF (.WAV, einschließlich WAV 
Extensible und RF64)

Sie können die folgenden Typen von Audiodateien in 
Pro Tools-Sessions importieren, wenn Sie 
beim Import in das aktuelle Dateiformat der Session 
konvertieren:

• AAC-Audio (auch Audio mit den 
Dateinamenerweiterungen AAC, MP4 und 
M4a)

• ACID-Dateien

• MP3

• MXF-Audio

• QuickTime (nur Mac)

• ReCycle-Dateien (REX 1 und 2)

• SD II

• SD I

• Sound Resource (AIFL – nur Mac)

Qualität der Samplerate-
Konvertierung
Die Sample Rate Conversion Quality-Einstellung 
legt die beim Konvertieren und Importieren von 
Audiomaterial in eine Session verwendete Qualität 
der Samplerate-Konvertierung fest. Sie kann auch 
verwendet werden, wenn Dateien mit 
unterschiedlichen Samplerates exportiert und auf 
die Festplatte gebounct werden. Es stehen fünf 
mögliche Einstellungen zur Verfügung, die von 

Low (schnellste Möglichkeit, jedoch niedrigste 
Qualität) bis Tweak Head (höchste Qualität, jedoch 
am langsamsten) reichen. Je höher die gewählte 
Konvertierungsqualität der Samplerate ist, 
desto mehr Zeit benötigt Pro Tools für die 
Verarbeitung der Audiodatei.

Die Optionen für die Konvertierungsqualität unter 
Sample Rate Conversion Quality können über die 
Dialogfelder „Import Audio“, „Import Session 
Data“, „Export Clips as Files“ und „Bounce to 
Disk“ aufgerufen werden. In allen diesen Fällen ist 
die Sample Rate Conversion Quality-Einstellung 
für das betreffende Dialogfeld lokal. Die Sample 

Rate Conversion Quality-Voreinstellung bezieht 
sich lediglich auf die Konvertierung beim 
Importieren per Drag & Drop.

So legen Sie die Konvertierungsqualität für die 
Samplerates beim Importieren von Audiodaten per 
Drag & Drop fest:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Wählen Sie im Sample Rate Conversion Quality-
Popup-Menü eine Qualitätseinstellung aus. Für 
die meisten Anwendungen erhalten Sie mit den 
Einstellungen Good oder Better sehr gute 
Ergebnisse.

3 Klicken Sie auf OK.
Pro Tools kann geschützte AAC- oder MP4-
Dateien mit der Dateinamenerweiterung .m4p 
nicht importieren. Diese Dateien unterliegen 
den Regelungen für digitale Rechte. Die Dialogfelder „Import Audio“, „Import 

Session Data“ und „Bounce To Disk“ bieten 
lokale Einstellungen für die 
Konvertierungsqualität der Samplerates.
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Konvertierung der Bitrate und 
Dithering
Wenn die Convert Copied Files on Import-
Voreinstellung aktiviert ist (Setup > Preferences > 

Processing), geschieht beim Import von 
Audiodateien, deren Bitrates von der Bitrate der 
aktuellen Session abweichen, Folgendes:

• Wenn Audiodaten mit einer leicht niedrigeren 
Bitrate im Vergleich zur Session importiert 
werden, konvertiert Pro Tools die Datei gemäß der 
Bitrate der Session, indem leere Bits hinzugefügt 
werden. Wird beispielsweise eine 16-Bit-Datei in 
eine 24-Bit-Session importiert, konvertiert 
Pro Tools die Datei in 24 Bit.

• Wenn Audiodaten mit einer höheren Bitrate im 
Vergleich zur Session importiert werden, wendet 
Pro Tools automatisch einen voreingestellten, 
rauschgeformten Dither an und konvertiert die 
Datei in die Bitrate der Session. Wird 
beispielsweise eine 24-Bit-Datei in eine 16-Bit-
Session importiert, wird automatisch ein Dither 
angewendet und die Datei wird in 16-Bit 
konvertiert.

Importieren von 
Interleaved-Dateien
Bei Verwendung des Import Audio-Befehls werden 
Interleaved-Stereodateien automatisch auf 
Stereospuren importiert. Bei Pro Tools HD 
werden Mehrkanal-Audiodateien automatisch in 
Spuren mit dem entsprechendem Mehrkanal-
Audioformat importiert. 

Wenn die Interleaved-Option für diese Session 
aktiviert ist oder beim Import aktiviert wird, werden 
Interleaved-Dateien in die Session importiert und 
behalten ihr Format. Ist diese Option nicht 
ausgewählt, werden die Interleaved-Dateien in 
Multimono-Dateien gesplittet.

Umgekehrt können gesplittete Stereo(Dual-Mono)-
Audiodateien automatisch auf Stereospuren 
importiert werden. Gesplittete Stereo-Audiodateien 
müssen die Kanal-IDs „.L“ und „.R“ in ihrer 
Bezeichnung tragen („Dateiname.L“ und 
„Dateiname.R“). Außerdem müssen die Dateien 
dieselbe Länge aufweisen. Unter Windows und im 
Mac/PC Compatibility-Modus tragen diese Dateien 
nach der Kanal-ID („.L“ bzw. „.R“) eine 
Dateinamenerweiterung mit insgesamt drei 
Buchstaben.
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Importieren von Dateien 
per Drag & Drop
Mit Pro Tools können Sie Audio-, MIDI-, Video- und 
Session-Dateien per Drag & Drop von Dateien aus 
einem Workspace-Browser, Windows Explorer oder 
Mac Finder auf das Pro Tools-Anwendungssymbol, in 
die Session-Timeline, eine Spur, die Tracks-Liste oder 
die Clipliste importieren. 

Die folgende Abbildung zeigt einige Optionen für 
das Importieren von Dateien per Drag & Drop aus 
Workspace-Browsern.

So importieren Sie Dateien in die Clipliste:

1 Wählen Sie Audio-, Video-, MIDI-, 
Clipgruppen-, REX- oder ACID-Dateien in 
einem Workspace-Browser, in Windows 
Explorer oder in Mac Finder aus. 

2 Ziehen Sie die ausgewählten Dateien auf 
die Clipliste. 

So importieren Sie Dateien in eine vorhandene Spur:

1 Wählen Sie die Dateien für den Import in einem 
Workspace-Browser, in Windows Explorer oder 
in Mac Finder aus. 

2 Ziehen Sie die ausgewählte Datei auf eine 
Position in einer vorhandenen, kompatiblen 
Spur. Die Datei wird importiert und an der 
gewünschten Stelle eingesetzt. 

So importieren Sie Dateien als neue Spur:

1 Wählen Sie die Dateien für den Import in einem 
Workspace-Browser, in Windows Explorer oder 
in Mac Finder aus. 

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie die Dateien bei gedrückter 
Umschalttaste an eine beliebige Stelle im Edit-
Fenster und legen Sie sie ab. 

• Legen Sie die Dateien in der Tracks-Liste ab.

• Legen Sie die Dateien in einem leeren Bereich 
des Edit-Fensters ab (unter einer Spur oder 
zwischen Spuren). 

Beim Importieren werden die Audiodateien 
nicht immer konvertiert und kopiert. Siehe 
„Audiokonvertierung beim Importieren“ auf 
Seite 326.

Durch das Importieren per Drag & Drop 
wechselt das Edit-Fenster nicht unbedingt in 
den Vordergrund. Beispielsweise bleibt beim 
Drag & Drop einer Datei vom Browser in 
eine Spur der Browser (nicht das Edit-
Fenster) im Vordergrund. Achten Sie immer 
darauf, welches Fenster oder welcher 
Browser aktiv und im Vordergrund ist.
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Importieren aus Workspace per Drag & Drop 

Workspace

Ablegen von Medien oder Session-Dateien in 
bestehenden Spuren oder der Tracks-Liste, 
um sie als neue Spuren hinzuzufügen

Ablegen von Dateien 
in der Clipliste, um sie 
zu importieren 
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So importieren und positionieren Sie Dateien 
in einer Spur:

1 Aktivieren Sie den Spot-Modus. 

2 Wählen Sie die Dateien für den Import in einem 
Workspace-Browser, in Windows Explorer oder 
in Mac Finder aus. 

3 Ziehen Sie die Dateien auf eine bestehende, 
kompatible Spur. Das Spot-Dialogfeld 
wird geöffnet.

4 Geben Sie die entsprechende Timecode-
Position ein (an der die importierte Datei 
platziert werden soll).

5 Klicken Sie auf OK.

So importieren und positionieren Sie eine 
Audiodatei anhand der zugehörigen Wellenform 
in Workspace-Browsern: 

1 Klicken Sie in einem Workspace-Browser 
bei gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) in der Wellenformanzeige 
eines Elements auf den ungefähren 
Referenzpunkt, der zur Platzierung in der Spur 
verwendet werden soll. 

2 Halten Sie die Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) gedrückt und ziehen Sie 
die Wellenform auf eine vorhandene Audiospur. 
Die Ausgangsdatei und die Zielspur müssen 
dieselbe Anzahl von Kanälen enthalten.

Einfügen am Spuranfang 
und Spurende
Sie können Dateien zu Spuren ziehen und am 
Anfang oder Ende der aktuellen Edit-Selektion oder 
des Einfügepunkts ablegen. Beim Einfügen am 
Anfang wird der Anfang der importierten Datei am 
Anfang der Edit-Selektion eingefügt. Beim 
Einfügen am Ende wird das Ende der importierten 
Datei am Anfang der Edit-Selektion eingefügt.

So importieren Sie und fügen ein Element 
am Spuranfang ein:

 Ziehen Sie mit gedrückter Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) die Datei 
auf eine Spur. 

So fügen Sie eine Datei am Anfang ein und 
kopieren sie in den Audio Files-Ordner:

 Ziehen Sie die Datei bei gedrückter Windows- 
und Alt-Taste (Windows) bzw. Befehls- und 
Wahltaste (Mac) auf eine Spur. 

So fügen Sie ein Element genau am Spuranfang ein:

 Ziehen Sie die Datei bei gedrückter Strg- und 
Windows-Taste (Windows) bzw. Befehls- und 
Ctrl-Taste (Mac) auf eine Spur. 

So fügen Sie eine Datei am Spurende ein und 
kopieren sie in den Audio Files-Ordner der Session: 

 Ziehen Sie die Datei bei gedrückter Strg-, Alt- 
und Windows-Taste (Windows) bzw. Befehls-, 
Wahl- und Ctrl-Taste (Mac) auf eine Spur. 

Elastic Audio beim Import
Beim Importieren einer beliebigen Audiodatei 
per Drag & Drop auf eine Elastic Audio-aktivierte 
Spur wird die Audiodatei importiert und 
gegebenenfalls analysiert. Wenn die importierte 
Audiodatei tickbasiert ist, wird sie mithilfe des 
Elastic Audio-Plug-Ins an das Tempo der Spur 
angeglichen. Wenn es sich um eine samplebasierte 
Audiodatei handelt (etwa bei einem einzelnen 
Schlagzeugton oder einem kurzen Soundeffekt), 
wird die ursprüngliche Dauer beibehalten. Längere 
Audiodateien ohne erkennbares Tempo bleiben 
ebenfalls samplebasiert.

Sie können Audiodaten auch per Drag & Drop 
importieren, um neue, tickbasierte Spuren mit 
aktiviertem Elastic Audio zu erstellen.

Beim Importieren von tickbasierten Audiodaten 
per Drag & Drop aus Workspace-Browsern in die 
Tracks-Liste oder einen leeren Bereich im Edit-
Fenster wird in Pro Tools eine neue, tickbasierte 
Spur mit aktiviertem Elastic Audio erstellt. Dies 
geschieht mithilfe des ausgewählten Standard-
Plug-Ins für Elastic Audio auf der Processing 
Preferences-Seite (siehe „Elastic Audio-
Optionen“ auf Seite 338).
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Wenn Sie eine Audiodatei per Drag & Drop aus 
Windows Explorer oder Mac Finder in die Tracks-
Liste oder in einen leeren Bereich im Edit-Fenster 
importieren, werden die Dateien je nach der 
ausgewählten Drag and Drop from Desktop 

Conforms to Session Tempo-Voreinstellung als 
samplebasiertes oder tickbasiertes Elastic Audio-
Material importiert (siehe „Drag and Drop From 
Desktop Conforms to Session Tempo“ auf Seite 338).

Importieren von Elastic Audio in 
die Clipliste aus Workspaces
Wenn die Audio Files Conform to Session Tempo-
Option aktiviert ist, werden beim Drag & Drop von 
tickbasierten Audiodaten aus Workspace-Browsern 
in die Clipliste (oder die Tracks-Liste) zwei separate 
Clips in der Clipliste erstellt. Der erste Clip ist einer 
samplebasierter Whole-File-Clip, der zweite ist eine 
tickbasierte Kopie desselben Clips.

Importieren von Tempo 
aus tickbasierten Audiodaten
Wenn keine Spuren in der Session vorhanden sind 
und Sie eine tickbasierte Audiodatei in die Clipliste, 
in die Tracks-Liste oder in einen leeren Bereich im 
Edit-Fenster importieren, werden Sie aufgefordert, 
entweder das Tempo aus der Datei zu importieren 
oder das standardmäßige Session-Tempo 
zu verwenden. Um das standardmäßige Session-
Tempo beizubehalten und zu erreichen, dass der 
Loop an das Session-Tempo angeglichen wird, 
klicken Sie auf Don't Import. 

Wenn die Session bereits mindestens eine Spur 
enthält, werden Sie unabhängig von der Spurart 
nicht dazu aufgefordert, das Tempo aus der Datei 
zu importieren. Die Datei wird an das Session-
Tempo angeglichen.

Importieren von Audiodateien 
und -Clips mit dem Import 
Audio-Befehl
Mit dem Import Audio-Befehl können 
Sie Audiodateien oder -Clips in Ihre 
Pro Tools-Session importieren.

So importieren Sie Audiodateien oder -Clips in 
eine Session mit Hilfe des Import Audio-Befehls:

1 Wählen Sie File > Import > Audio. 

2 Wählen Sie im Import Audio-Dialogfeld eine 
Audiodatei aus, um ihre Eigenschaften und die 
dazugehörigen Clips anzuzeigen.

Sie können auch nur einen bestimmten Dateityp 
(etwa WAV) anzeigen lassen, indem Sie ihn im 
Show-Popup-Menü auswählen. Um alle 
unterstützten Dateitypen anzuzeigen, wählen Sie im 
Show-Popup-Menü die All Documents-Option.

Informationen zum Importieren ganzer Spuren 
aus anderen Sessions finden Sie unter 
„Importieren von Session-Daten“ auf Seite 346.

Import Audio-Dialogfeld
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In der Importliste werden Audiodateien und -Clips 
durch unterschiedliche Symbole gekennzeichnet.

3 Um eine Vorschau einer ausgewählten Datei oder 
eines Clips vor dem Importieren anzuzeigen, 
klicken Sie auf die Play- und Stop-Schaltflächen 
im Import Audio-Dialogfeld.

Passen Sie die Vorschaulautstärke mit dem 
vertikalen Regler an. Mit dem horizontalen Regler 
unterhalb der Play- und Stop-Schaltflächen 
können Sie zu einer bestimmten Stelle in der Datei 
navigieren. 

Als Abhör-Ausgangspfad ist standardmäßig das 
Kanalpaar 1–2 eingestellt. Bei Pro Tools-
Systemen mit mehr als 2 Ausgangskanälen kann 
der Abhörpfad im I/O Setup-Dialogfeld geändert 
werden (siehe „Abhörpfade“ auf Seite 78).

4 Sie haben folgende Möglichkeiten:

• Um eine Datei oder einen Clip in die Importliste zu 
übernehmen, wählen Sie das Element aus und 
klicken Sie auf Add oder Convert. 

• Um alle Dateien und Clips im aktuellen 
Verzeichnis zu importieren, klicken Sie auf Add 

All oder Convert All. 

• Um eine Datei oder einen Clip aus der 
Importliste zu entfernen, wählen Sie das 
Element aus und klicken Sie auf Remove. 

• Um alle Dateien oder Clips zu entfernen, klicken 
Sie auf Remove All.

5 Wenn Sie alle Audiodateien und -Clips 
zur Importliste hinzugefügt haben, können Sie 
die Konvertierung der Samplerate wie 
im Folgenden beschrieben anwenden:

• Aktivieren Sie „Apply SRC“.

• Geben Sie die Source Sample Rate an, indem 
Sie eine Zahl eingeben oder im Popup-Menü 
eine Samplerate auswählen.

• Wählen Sie die Konvertierung der Samplerate 
im Quality-Popup-Menü aus. Diese Einstellung 
setzt die Sample Rate Conversion Quality-
Einstellung auf der Processing Preferences-
Seite außer Kraft.

6 Klicken Sie auf Done.

7 Wenn Sie Dateien kopieren oder konvertieren, 
geben Sie einen Speicherort für die neuen 
Dateien an. Wählen Sie auf einem gültigen 
Audiolaufwerk einen Ordner, wie etwa den 
Audio Files-Ordner der aktuellen Session. 

Symbole für Datei und Clip im Import Audio-Dialogfeld

Bei Mac müssen Sound Resource-Dateien die 
Erweiterung „.SFIL“ haben, um in 
Pro Tools importiert werden zu können. 

Über das Vorschaulautstärke-Steuerelement im 
Import Audio-Dialogfeld beeinflussen Sie die 
Lautstärke der Vorschau beim Abhören von 
Clips in der Clipliste.

Audiodateisymbol

Audioclip-Symbol
Mit Pro Tools können Sie einer Session 
Dateien mit einer abweichenden Samplerate 
hinzufügen. Im Comments-Feld des Import 
Audio-Dialogfelds wird eine Warnmeldung 
angezeigt, dass diese Dateien mit der 
falschen Geschwindigkeit und Tonhöhe 
wiedergegeben werden, wenn sie nicht 
konvertiert werden.

Drücken Sie Befehl + W (Mac) bzw. Alt + E 
(Windows), um „Done“ auszuwählen. 
Drücken Sie Befehl + „.“ (Punkt) (Mac) oder 
Esc, um abzubrechen.
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8 Wählen Sie im Audio Import Options-Dialogfeld 
aus, wo die importierten Dateien in der Session 
platziert werden sollen.

New Track – jede Audiodatei wird in eine eigene 
Spur und in die Clipliste importiert. 

Beim Importieren von Audiodaten in eine 
Spur können Sie in der Spur die Stelle auswählen, 
an der die Audiodatei beginnen 
soll (beispielsweise am Beginn der Session).

Clip List – Audiodateien werden in die Clipliste 
importiert, ohne dass eine neue Spur erstellt wird. 
Importierte Audiodateien werden in der Clipliste 
angezeigt und können dann in Audiospuren 
gezogen werden.

9 Wenn Sie eine neue Spur erstellen möchten, 
wählen Sie unter „Location“ einen Speicherort 
in der Spur für die importierte Datei aus.

Session Start – platziert die Datei oder den Clip 
am Start der Session. 

Song Start – setzt den Beginn der Datei oder des 
Clips auf den Startpunkt des Songs. 

Selection – setzt den Beginn der Datei oder des 
Clips auf den Edit-Cursor oder auf den Beginn 
einer Auswahl in der Timeline.

Spot – zeigt das Spot-Dialogfeld an, über das Sie die 
Datei oder den Clip an präzisen Positionen, basierend 
auf einer der Zeitskalen, positionieren können.

10 Klicken Sie auf OK.

Importieren von 
Audiomaterial von Audio-CDs
In Pro Tools können Sie Spuren von Audio-CDs 
mit denselben Verfahren importieren wie beim 
Import von Audiodateien:

• CD-Audiodateien aus dem CD-Ordner ziehen

• Dateien aus Workspace-Browser ziehen

• Verwenden Sie den Import Audio-Befehl.

Stellen Sie vor dem Import von CD-Audio sicher, 
dass auf der Festplatte genügend Platz für die 
konvertierten Audiodateien vorhanden ist.

Da die Übertragung rein digital erfolgt, kommt es 
zu keinen Signalverlusten.

Die Samplerate bei CDs beträgt 44,1 kHz. Wenn 
als Samplerate in Ihrer Session 48 kHz oder höher 
eingestellt ist, konvertiert Pro Tools die 
Samplerate des importierten Audiomaterials. 
Stellen Sie vor dem Importieren von CD-
Audiomaterial die Sample Rate Conversion 

Quality-Voreinstellung ein. Weitere Informationen 
finden Sie unter „Qualität der Samplerate-
Konvertierung“ auf Seite 327.

Audio Import Options-Dialogfeld

Wenn Sie CD-Audio per Drag & Drop 
importieren, können Sie weiterhin im 
Vordergrund der Session arbeiten (etwa im 
Mix- oder Edit-Fenster), während der Task 
Manager (Window > Task Manager) das 
Audiomaterial im Hintergrund importiert 
und konvertiert, bis der Importvorgang 
abgeschlossen ist). Weitere Informationen 
zum Task Manager finden Sie unter „Task 
Manager-Fenster“ auf Seite 321.
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Importieren von ACID- und 
REX-Dateien
ACID-Dateien und REX 1- und 2-Dateien werden in 
den Audiodateityp der Session konvertiert. Abhängig 
von den Voreinstellungen können ACID- und REX-
Dateien als samplebasierte Clips oder als tickbasierte 
Elastic Audio-Clips importiert werden. Pro Tools 
verwendet ausschließlich für REX-Dateien beliebige 
Slice-Daten, um Event-Marker absolut zuverlässig 
zu erstellen. ACID-Dateien werden für Elastic 
Audio-Events genau wie WAV-Dateien analysiert. 
Auf diese Weise werden Events mit einem 
unterschiedlichen Grad an Zuverlässigkeit erkannt.

REX-Dateien können auch als tickbasierte 
Clipgruppe importiert werden. 

So importieren Sie ACID- und REX-Dateien als 
samplebasierte Clips:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Deaktivieren Sie die Import REX Files as Clip 

Groups-Option.

3 Wählen Sie No Files als Drag and Drop 

from Desktop Conforms to Session 

Tempo-Voreinstellung.

4 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

5 Stellen Sie beim Importieren per Drag & Drop 
aus Workspace-Browsern sicher, dass die Audio 

Files Conform to Session Tempo-
Option deaktiviert ist.

6 Importieren Sie die gewünschten ACID- und 
REX-Dateien per Drag & Drop aus einem 
Workspace-Browser bzw. vom Desktop oder 
mit dem Import Audio-Befehl (siehe 
„Importieren von Audiodateien und -Clips mit 
dem Import Audio-Befehl“ auf Seite 332).

So importieren Sie ACID- und REX-Dateien als 
tickbasierte Elastic Audio-Clips:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Deaktivieren Sie die Import REX Files as Clip 

Groups-Option.

3 Wählen Sie REX and ACID Files Only oder 
All Files als Drag and Drop from Desktop 

Conforms to Session Tempo-Voreinstellung.

4 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

5 Sie haben folgende Möglichkeiten:

• Importieren der gewünschten REX-Dateien per 
Drag & Drop aus einem Workspace-Browser

• Importieren der gewünschten REX-Dateien per 
Drag & Drop vom Desktop

• Verwenden Sie den Import Audio-Befehl 
(siehe „Importieren von Audiodateien und -Clips 
mit dem Import Audio-Befehl“ auf Seite 332).

So importieren Sie REX-Dateien als tickbasierte 
Clipgruppen:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Wählen Sie die Import REX Files as Clip 

Groups-Option.

3 Aktivieren Sie die Automatically Create Fades-
Option, um Crossfades in Echtzeit auf die Dateien 
anzuwenden (siehe „Automatische Fades bei 
importierten REX-Dateien“ auf Seite 336).

4 Wählen Sie REX and ACID Files Only oder All 

Files als Drag and Drop from Desktop Conforms 

to Session Tempo-Voreinstellung.

Informationen zu Elastic Audio finden 
Sie unter Kapitel 40: „Elastic Audio“.

Informationen zu Clipgruppen finden 
Sie unter „Clipgruppen“ auf Seite 877.



Pro Tools-Referenzhandbuch336

5 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

6 Sie haben folgende Möglichkeiten:

• Importieren der gewünschten REX-Dateien per 
Drag & Drop aus einem Workspace-Browser 

• Importieren der gewünschten REX-Dateien 
per Drag & Drop vom Desktop

• Verwenden Sie den Import Audio-Befehl 
(siehe „Importieren von Audiodateien und -Clips 
mit dem Import Audio-Befehl“ auf Seite 332).

Automatische Fades bei importierten REX-Dateien

Wenn die Import REX Files as Clip Groups-Option 
auf der Processing Preferences-Seite aktiviert ist, 
können in Pro Tools automatisch Crossfades in 
Echtzeit auf die Clips oder „Slices“ in importierten 
REX-Dateien angewendet werden. 

So wenden Sie Crossfades in Echtzeit auf REX-
Dateien an:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Aktivieren Sie die Import REX Files as Clip 

Groups-Option.

3 Aktivieren Sie die Automatically Create Fades-
Option.

4 Klicken Sie im Preferences-Dialogfeld auf 
die Editing-Registerkarte. 

5 Klicken Sie in den Fade-Standardeinstellungen 
(Default Fade Settings) auf REX.

6 Wählen Sie im REX Auto-Crossfades-
Dialogfeld die gewünschten Formen für 
die Crossfades aus und klicken Sie auf OK. 

7 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

Importieren von Mehrkanal-
Audiodateien von einem 
transportablen Rekorder
Sie können monophone und polyphone Audiodateien, 
die von einem tragbaren Rekorder aufgenommen 
wurden, mit allen verfügbaren Importmethoden 
in Pro Tools importieren. Wenn Sie diese Dateitypen 
importieren, müssen sie in ein mit Pro Tools 
kompatibles Audioformat konvertiert werden.

Importieren von monophonen 
Audiodateien
Eine monophone Audiodatei enthält einen 
Monokanal und relevante Metadaten aus einer 
einzelnen Mehrkanal-Aufnahme. 

Wenn Sie monophone Audiodateien importieren, 
die gleichzeitig aufgenommen wurden, werden 
diese in Mehrkanal-Clips konvertiert und 
zusammen in der Clipliste angezeigt. Alle 
Metadaten werden mit den Dateien importiert.

Importieren von polyphonen 
Audiodateien
Eine polyphone Audiodatei enthält mehrere 
Monokanäle und zugehörige Metadaten, 
die gleichzeitig in einer Mehrkanal-Aufnahme 
aufgenommen wurden.

Beim Import einer polyphonen Audiodatei in 
Pro Tools wird diese in einzelne monophone 
Audiodateien auf der Festplatte geteilt: eine Datei 
für jeden Kanal. Die Clips für einen Kanal werden 
in der Playlist angezeigt. Ein Mehrkanal-Clip wird 
in der Clipliste angezeigt, die Kanäle können 
darunter erweitert werden. Alle Metadaten werden 
mit den Dateien importiert. 

Abhängig von den Bearbeitungsaktionen 
oder Tempoänderungen nach dem Import der 
REX-Dateien können die Fades gelöscht 
werden. In diesem Fall müssen Sie 
sie manuell neu erstellen.

Weitere Informationen zum Importieren von 
Dateien von einem tragbaren Rekorder 
finden Sie unter Kapitel 51: „Arbeit mit 
tragbaren Rekordern und Pro Tools“.
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Importoptionen und 
-voreinstellungen
Pro Tools bietet mehrere Optionen und 
Voreinstellungen, die den Audioimport beeinflussen. 
Konfigurieren Sie Pro Tools entsprechend der am 
häufigsten von Ihnen verwendeten Arbeitsabläufe. 
Wenn Sie beispielsweise regelmäßig REX-Dateien für 
loopbasierte Komposition importieren, können 
Sie Pro Tools so konfigurieren, dass immer REX-
Dateien importiert werden, um das Tempo anzupassen 
und neue, tickbasierte Elastic Audio-Spuren zu 
erstellen.

Convert Imported “WAV” Files To 
AES31/BroadcastWave – wenn diese Option 
aktiviert ist, ist sie für alle importierten WAV-
Dateien wirksam und gewährleistet die 
Kompatibilität mit dem AES31/EBU-Standard.

Automatically Copy Files on Import – wenn diese 
Option ausgewählt ist, werden alle per Drag & 
Drop importierten Audiodateien im Audio Files-
Ordner der aktuellen Session gespeichert, 
unabhängig davon, ob sie zum Dateityp, 
der Bitrate oder der Samplerate der aktuellen 
Session konvertiert werden müssen. Zusätzlich 
wird bei Auswahl dieser Option Copy from Source 

Media zur Standardeinstellung des Import Session 
Data-Dialogfelds. Die Automatically Copy Files on 

Import-Voreinstellung hat keine Auswirkungen 
auf den Import Audio-Befehl.

Convert Copied Files to Session Format – wenn 
diese Option ausgewählt ist, werden Dateien mit vom 
aktuellen Session-Dateiformat abweichenden 
Dateiformaten kopiert und beim Importieren in das 
aktuelle Audiodateiformat sowie die Bitrate und 
Samplerate der Session umgewandelt. Wenn 
beispielsweise das Session-Dateiformat WAV mit 
24 Bit bei 48 kHz ist und Sie eine AIF-Datei mit 
16 Bit und 44,1 kHz importieren, wird die Datei beim 
Importieren kopiert und in eine WAV-Datei mit 
24 Bit bei 48 kHz umgewandelt. Wenn diese Option 

nicht ausgewählt ist, behalten kopierte Dateien ihr 
ursprüngliches Format bei (solange dieses 
Dateiformat mit Pro Tools kompatibel ist; 
andernfalls muss es umgewandelt werden).

Do Not Convert Sample Rate on Import – wenn 
diese Option ausgewählt ist, werden Dateien mit 
von der Session-Samplerate abweichenden 
Samplerates beim Importieren in die Session nicht 
automatisch umgewandelt. Dies bedeutet, dass 
Dateien mit nicht übereinstimmenden Samplerates 
mit unterschiedlicher Geschwindigkeit 
wiedergegeben werden (und die Tonhöhe 
im Vergleich zur ursprünglichen Aufnahme (oder 
Umwandlung) ändert sich).

Import REX Files as Clip Groups – bei Auswahl 
dieser Option werden REX-Dateien als Clipgruppen 
importiert. Alle zugrunde liegenden Slices werden 
als individuelle Clips innerhalb der Clipgruppe 
importiert. Wenn diese Option nicht ausgewählt ist, 
werden REX-Dateien beim Import in eine Session in 
das Audiodateiformat der Session konvertiert. Die 
individuellen Slices werden konsolidiert und die 
Slice-Informationen dienen als Informationen für die 
Elastic Audio-Analyse. Diese Dateien sind auch nach 
Import und Konvertierung Tick-basiert. 

Automatically Create Fades – ist diese Option 
aktiviert, werden automatisch Crossfades auf die 
in Slices unterteilten Clips innerhalb der 
Clipgruppen angewendet, die durch den Import der 
REX-Dateien erstellt wurden. Wenn die Import 

REX Files as Clip Groups-Option nicht ausgewählt 
ist, steht die Automatically Create Fades-Option 
nicht zur Verfügung. 

Klicken Sie zum Ändern der Fade-
Standardeinstellungen von REX-Dateien auf der 
Editing Preferences-Registerkarte im Default Fade 
Settings-Bereich auf die REX-Schaltfläche (siehe 
„Fades Editing-Voreinstellung“ auf Seite 339).
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Drag and Drop From Desktop Conforms 
to Session Tempo

Die Drag and Drop From Desktop Conforms to 

Session Tempo-Optionen legen fest, ob Dateien 
im REX-, ACID- oder einem beliebigen anderen 
Audiodateiformat beim Drag & Drop aus 
Windows Explorer oder Mac Finder als 
tickbasierte Elastic Audio-Dateien importiert und 
an das Session-Tempo angeglichen werden.

None – wenn diese Option aktiviert ist, werden 
alle Audiodateien einschließlich REX- und ACID-
Dateien beim Importieren per Drag & Drop aus 
Windows Explorer oder Mac Finder nicht an das 
Session-Tempo angeglichen. Sie werden als 
samplebasierte Dateien importiert und in das 
Audiodateiformat der Session konvertiert.

REX and ACID Files Only – wenn diese Option 
aktiviert ist, werden nur REX- und ACID-Dateien 
beim Importieren per Drag & Drop aus dem Windows 
Explorer oder Mac Finder an das Session-Tempo 
angeglichen. REX-Dateien werden entweder als 
tickbasierte Elastic Audio-Dateien oder (falls die 
Import REX Files as Clip Groups-Option aktiviert 
ist) als tickbasierte Clipgruppen importiert. 

All Files – wenn diese Option aktiviert ist, werden 
alle Audiodateien als tickbasierte Elastic Audio-
Dateien importiert und an das Tempo der Session 
angeglichen.

Sample Rate Conversion Quality

Die Sample Rate Conversion Quality-
Voreinstellung legt die beim Konvertieren 
von Audiomaterial in eine Session verwendete 
Qualität der Samplerate-Konvertierung beim 
Importieren per Drag & Drop fest. Die 
Konvertierung der Samplerate findet bei einer 
Reihe von Pro Tools-Vorgängen statt, u. a. beim 
Konvertieren und Importieren von Audiodateien 
mit unterschiedlichem Format in eine Session und 
beim Bouncing und Speichern von Spuren mit 

einer anderen Samplerate oder Bitrate. Je höher 
die gewählte Konvertierungsqualität der 
Samplerate ist, desto mehr Zeit benötigt Pro Tools 
für die Verarbeitung der Audiodatei.

Elastic Audio-Optionen

Mit den Elastic Audio-Voreinstellungen wird 
festgelegt, welche Elastic Audio-Plug-Ins für die 
Vorschau und den Import verwendet werden und 
ob neue Spuren mit aktiviertem Elastic Audio über 
das ausgewählte Plug-In erstellt werden.

Default Plug-In – mit dieser Option können Sie 
jedes Real-Time Elastic Audio-Plug-In als 
Standard-Plug-In für die Vorschau und das 
Importieren von Elastic Audio verwenden. 
Das ausgewählte Standard-Elastic-Audio-Plug-In 
wird auch verwendet, wenn neue Spuren mit 
aktiviertem Elastic Audio erstellt werden. Der 
Elastic Audio-Plug-In-Selektor in Workspace-
Browsern übernimmt das ausgewählte Standard-
Plug-In. Durch Ändern des ausgewählten Plug-Ins 
in Workspace-Browsern wird dadurch auch das 
ausgewählte Default Plug-In in den Processing-
Voreinstellungen aktualisiert.

Default Input Gain – hier können Sie den 
Signaleingang für Elastic Audio-Plug-Ins um 0 bis 
–6 dB für die Vorschau und den Import dämpfen. 
Wenn aufgrund der Elastic Audio-Verarbeitung 
während des Vorhörens oder nach dem Import eine 
Übersteuerung auftritt, sollten Sie die Default Input 

Gain-Option so einstellen, dass der 
Audiosignaleingang für die Elastic Audio-
Bearbeitung leicht abgeschwächt wird. Diese 
Einstellung gilt auch für Audiomaterial, das in eine 
Elastic Audio-fähige Spur importiert wird.

Wenn Sie Clips (durch Deaktivieren von Elastic 
Audio für die Spur) auf einer Spur speichern, 
die mit der Standard-Eingangsverstärkung 
importiert wurden, wird die clipbasierte 
Eingangsverstärkung auf 0 zurückgesetzt.
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Das Elastic Properties-Fenster übernimmt die 
Einstellung der Default Input Gain-Option. Um eine 
weitere Clip-basierte Eingangsverstärkung für 
die Elastic Audio-Bearbeitung anzuwenden, wählen 
Sie den Clip aus und passen Sie die Input Gain-
Einstellung im Elastic Properties-Fenster an (siehe 
„Elastic Properties-Fenster“ auf Seite 927).

Enable Elastic Audio on New Tracks – wenn 
diese Option ausgewählt ist, werden neue Spuren 
mit aktiviertem Elastic Audio erstellt. 
Das ausgewählte Elastic Audio-Standard-Plug-In 
wird verwendet. Beim Importieren von 
Audiodaten in neue Spuren werden die neuen 
Spuren mit aktiviertem Elastic Audio erstellt, falls 
diese Option aktiviert ist.

Spuren-Voreinstellung

Wenn die New Tracks Default To Tick Timebase-
Option aktiviert ist, basieren alle neuen Spuren 
standardmäßig auf Ticks. Dies gilt auch für den 
Import von Audiodaten in neue Spuren. Wenn die 
Option deaktiviert ist, basieren Audio-, Auxiliary-
Eingangs-, Master-Fader- und VCA-Spuren (nur 
Pro Tools HD) auf Samples. MIDI- und 
Instrumentenspuren basieren standardmäßig 
immer auf Ticks.

Fades Editing-Voreinstellung

Die Fade-Standardeinstellungen (Default Fade 

Settings) für REX-Dateien in den Editing-
Voreinstellungen ermöglichen die Auswahl einer 
Standard-Hüllkurvenform für Fades und Crossfades 
zwischen Clips („Slices“) in importierten REX-
Dateien. Fades werden nur auf importierte REX-
Dateien angewendet, wenn die Optionen Import REX 

Files as Clip Groups und Automatically Create Fades 
auf der Processing Preferences-Seite aktiviert sind.

Wenn die Enable Elastic Audio on New Tracks-
Option ausgewählt ist, können Sie auch die New 
Tracks Default to Tick Timebase-Option in den 
Editing-Voreinstellungen auswählen.

REX Auto-Crossfades-Dialogfeld
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Exportieren von Audio
Pro Tools unterstützt das Exportieren von 
Audioclips als Audiodateien, das Exportieren 
von Audiodateien des linken und rechten 
Audiokanals als Interleaved-Stereodateien und das 
Exportieren von Clip-Informationen.

Sie können Audiodateien auch durch Bouncing 
oder Zusammenfügen aus Pro Tools exportieren. 
Weitere Informationen dazu finden Sie unter 
„Bounce to Disk“ auf Seite 1141 und 
„Konsolidieren von Clips“ auf Seite 621.

Exportieren eines Clips als 
neue Audiodatei
Mit dem Export Clips As Files-Befehl können Sie 
Clips als Audiodateien exportieren. Benutzen Sie 
diesen Befehl, wenn Sie einen Clip in anderen 
Sessions (oder anderen Audio-Anwendungen) 
verwenden möchten, ohne die gesamte Quelldatei 
zu importieren. 

Dieser Befehl bietet auch eine Möglichkeit, Clips 
in ein anderes Audioformat, eine andere 
Samplerate oder Bitrate zu konvertieren.

So exportieren Sie Clips als neue Audiodateien:

1 Wählen Sie in der Clipliste die zu exportierenden 
Clips aus.

2 Wählen Sie im Menü der Clipliste den Export 

Clips as Files-Befehl. 

3 Legen Sie im Export Selected-Dialogfeld 
Dateityp (File Type), Format, Bitrate (Bit Depth) 
und Samplerate (Sample Rate) fest. Stellen 
Sie außerdem die Konvertierungsqualität 
(Conversion Quality) ein und wählen Sie das 
Zielverzeichnis (Destination Directory) aus.

Beim Export von Clips mit einer niedrigeren Bitrate 
wird Dither (mit oder ohne Rauschformung) 
angewendet, wie in der folgenden Tabelle dargestellt.

Verformte Clips (Elastic Audio) werden 
unverformt mit der ursprünglichen 
Dauer exportiert.

Export Selected-Dialogfeld

Dithering und Rauschformung mit dem 
Export Selected-Dialogfeld

Bit Depth Dither Rauschformung

32-Bit-Gleitkomma 
auf 32-Bit-
Gleitkomma

Ja Ja

32-Bit-Gleitkomma 
auf 24 Bit

Ja Ja
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Die Dither-Einstellung zum Konvertieren ist 
das Avid Dither-Plug-In (Rauschformung aktiviert 
oder deaktiviert).

4 Wenn Sie auf Gobbler veröffentlichen möchten, 
wählen Sie die Share With Gobbler-Option (siehe 
„Veröffentlichen auf Gobbler“ auf Seite 1152).

5 Wenn Sie auf SoundCloud veröffentlichen 
möchten, wählen Sie die Share with 

SoundCloud-Option (siehe „Veröffentlichen 
auf SoundCloud“ auf Seite 1150).

6 Wählen Sie eine Option zur Vorgehensweise 
bei doppelt vorhandenen Dateinamen aus. 

Prompting for Each Duplicate – wenn eine Datei 
denselben Namen wie eine bereits im Zielverzeichnis 
vorhandene hat, werden Sie aufgefordert, 
einen Dateinamen anzugeben. 

Auto Renaming – fügt dem Namen einer doppelt 
vorhandenen Datei automatisch am Ende des 
Dateinamens eine Zahl hinzu (etwa Datei_01). 

Replacing with New Files – ersetzt Dateien mit 
demselben Namen durch neue.

7 Klicken Sie zum Exportieren der neuen 
Audiodateien auf Export.

Exportieren von Stereo- oder 
Mehrkanal-Interleaved-Dateien
Mit dem Export Clips As Files-Befehl können Sie 
Audioclips zur Verwendung in anderen 
Anwendungen in Stereo- oder Mehrkanal-Interleaved-
Dateien exportieren. (Da Pro Tools Interleaved-
Dateien nicht direkt in der Timeline nutzen kann, 
müssen sie vorher in mehrere Monodateien konvertiert 
werden.) Beispiel: Damit dies bei einer Stereodatei 
funktioniert, müssen die ausgewählten Clips 
identische Namen mit dem Suffix „.L“ bzw. „.R“ 
haben (etwa „Gesang_01.L“ und „Gesang_01.R“). 
Diese Clips werden in der Clipliste als Stereoclips 
angezeigt.

Mit Pro Tools HD können Sie auch Mehrkanal-
Interleaved-Dateien in einem beliebigen 
unterstützten Format bouncen. 

So exportieren Sie Clips als Stereo- oder 
Mehrkanal-Interleaved-Dateien:

1 Wählen Sie in der Clipliste oder der Playlist 
der Spur den Stereo- oder Mehrkanal-Audioclip 
aus. Wenn die Clips in der Session auf 
Monospuren liegen, wählen Sie beide Monoclips.

2 Wählen Sie im Menü der Clipliste den Export 

Clips as Files-Befehl.

32-Bit-Gleitkomma 
auf 16 Bit

Ja Ja

32-Bit-Gleitkomma 
auf 8 Bit

Ja Nein

24 Bit auf 32-Bit-
Gleitkomma

Nein Nein

24 Bit auf 24 Bit Nein Nein

24 Bit auf 16 Bit Ja Ja

24 Bit auf 8 Bit Ja Nein

16 Bit auf 32-Bit-
Gleitkomma

Nein Nein

16 Bit auf 24 Bit Nein Nein

16 Bit auf 16 Bit Nein Nein

16 Bit auf 8 Bit Ja Nein

Weitere Informationen zum Dithering finden 
Sie unter „Dither“ auf Seite 1032.

Dithering und Rauschformung mit dem 
Export Selected-Dialogfeld

Bit Depth Dither Rauschformung
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3 Wählen Sie im Export Selected-Dialogfeld im 
Format-Popup-Menü die Stereo Interleaved-
Option. Bei Mehrkanal-Clips erzeugt die 
Stereo Interleaved-Option eine Mehrkanal-
Interleaved-Datei.

4 Konfigurieren Sie alle anderen Einstellungen 
und klicken Sie auf Export, um die neue 
Interleaved-Stereodatei zu exportieren.

Exportieren von Clipdefinitionen
Pro Tools speichert in jeder Session Definitionen 
von Clips für Audiodateien. Wenn Sie die Clips 
einer Audiodatei in einer anderen Session oder in 
einer anderen Anwendung, die diese Clips 
unterstützt, verwenden möchten, können Sie die 
Informationen zu den Clips exportieren. 

Mit dem Export Clip Definitions-Befehl werden im 
Gegensatz zum Export Clips as Files-Befehl Clips 
nicht als Audiodateien exportiert. Stattdessen 
werden Verweise auf Clips innerhalb der 
übergeordneten Quelldatei gespeichert.

So exportieren Sie Clipdefinitionen für eine 
Audiodatei:

1 Wählen Sie in der Clipliste die Clips bzw. 
Clipgruppen aus, für die Definitionen exportiert 
werden sollen. Sie brauchen die übergeordnete 
Datei des Audioclips nicht auszuwählen.

2 Wählen Sie im Cliplisten-Menü den Export Clip 

Definitions-Befehl.

3 Klicken Sie auf Export.

Importieren von MIDI-Dateien
Sie können Standard-MIDI-Dateien (SMF) in 
Pro Tools-Sessions importieren.

Pro Tools bietet mehrere Möglichkeiten zum 
Importieren von MIDI-Dateien in eine geöffnete 
Session.

• „Importieren von MIDI-Dateien mit den 
Menübefehlen von Pro Tools“ auf Seite 343.

• „Importieren von MIDI-Dateien per Drag & 
Drop“ auf Seite 344.

Pro Tools unterstützt keine proprietären 
Sequenzdateien anderer Anwendungen. 
Um Sequenzen aus anderen MIDI-Anwendungen 
in eine Pro Tools-Session zu importieren, müssen 
Sie diese zuerst als Standard-MIDI-Dateien 
speichern. Nähere Informationen zum Speichern 
von Standard-MIDI-Dateien finden Sie in der 
Dokumentation des entsprechenden Herstellers.

Es gibt zwei Arten von Standard-MIDI-Dateien. 
Beide werden von Pro Tools unterstützt:

• MIDI-Dateien des Typs 0 speichern die Daten aller 
MIDI-Kanäle in einer einzigen Spur. Beim 
Importieren dieser Dateien sortiert Pro Tools die 
Daten nach Kanälen und platziert die Daten zu 
jeder Spur in separate Clips und Spuren.

• MIDI-Dateien des Typs 1, manchmal auch als 
mehrspurige MIDI-Dateien bezeichnet, 
enthalten mehrere Spuren mit MIDI-Daten. 
Beim Importieren dieser Dateien werden die 
Daten jeder Spur in der Pro Tools-Session in 
eine eigene neue MIDI-Spur platziert.

Wenn Sie Pro Tools-Session-Daten in eine 
andere Session übertragen möchten, sollten 
Sie Clipdefinitionen für Sessions, die 
mehrere per Loop-Aufnahme erstellte Takes 
enthalten, exportieren.
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Importieren von MIDI-Dateien mit 
den Menübefehlen von Pro Tools
Pro Tools bietet Befehle zum Importieren von 
MIDI-Dateien.

So importieren Sie Standard-MIDI-Dateien mithilfe 
des File-Menüs in Pro Tools in eine Session:

1 Wählen Sie File > Import > MIDI und 
anschließend die zu importierende Datei.

2 Wählen Sie im MIDI Import Options-
Dialogfeld aus, wo die importierte Datei 
platziert werden soll:

New Track – erstellt eine neue Spur, in den 
die Datei importiert wird.

Clip List – importiert die Datei in die Clipliste, von 
wo aus sie in Spuren platziert werden kann.

3 Wenn Sie eine neue Spur erstellen möchten, 
wählen Sie unter „Location“ einen Speicherort 
in der Spur für die importierte Datei aus.

Session Start – platziert die Datei oder den Clip 
am Start der Session. 

Song Start – setzt den Beginn der Datei auf 
den Startpunkt des Liedes. 

Selection – setzt den Beginn der Datei auf 
den Bearbeitungscursor oder den Beginn 
einer Auswahl in der Timeline.

Spot – zeigt das Spot-Dialogfeld an, über das Sie 
die Datei an präzisen Positionen, basierend auf 
einer der Zeitskalen, positionieren können.

4 Wählen Sie eine der folgenden Importoptionen:

Import Tempo Map From MIDI File – wenn diese 
Option ausgewählt wird, werden etwaige vorhandene 
Tempo- und Taktartzuweisungen durch die Tempo- 
und Taktartdaten aus der MIDI-Datei überschrieben. 

Import Key Signature From MIDI File – wenn diese 
Option ausgewählt wird, werden etwaige 
Generalvorzeichen durch die Generalvorzeichen-
Daten aus der MIDI-Datei überschrieben. 

Remove Existing Instrument Tracks – wenn diese 
Option ausgewählt wird, werden alle bestehenden 
Instrumentenspuren gelöscht. Aktuelle MIDI-Spuren 
werden dabei nicht entfernt. Alle vorhandenen MIDI-
Clips verbleiben in der Clipliste.

Remove Existing MIDI Tracks – wenn diese Option 
ausgewählt wird, werden alle bestehenden MIDI-
Spuren gelöscht. Aktuelle Instrumentenspuren 
werden dabei nicht entfernt. Alle vorhandenen MIDI-
Clips verbleiben in der Clipliste.

Remove Existing MIDI Clips – wenn diese Option 
ausgewählt ist, werden vorhandene MIDI-Clips 
(sämtliche Daten auf allen MIDI- und 
Instrumentenspuren) gelöscht. Vorhandene MIDI- und 
Instrumentenspuren bleiben allerdings erhalten. 

5 Klicken Sie auf OK.

Die MIDI-Datei wird entsprechend den Einstellungen 
im Import MIDI Settings-Dialogfeld importiert.

6 Klicken Sie im Mix-Fenster für jede neue Spur auf 
den MIDI Output-Selektor und weisen Sie ihm ein 
MIDI-Instrument und einen Kanal zu.

MIDI Import Options-Dialogfeld

Wenn die Standard-MIDI-Datei Marker 
enthält, werden diese nur importiert, wenn in 
der aktuellen Session noch keine Marker 
vorhanden sind.
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Importieren von MIDI-Dateien 
per Drag & Drop
Sie können MIDI-Dateien aus einem Workspace-
Browser oder dem Windows Explorer bzw. Mac 
Finder in die Timeline, eine Spur, eine Tracks-
Liste oder die Clipliste ziehen.

So importieren Sie MIDI-Daten in die Clipliste:

1 Markieren Sie MIDI-Dateien in einem 
Workspace-Browser, im Windows Explorer 
oder Mac Finder. 

2 Ziehen Sie die Dateien in die Clipliste 
der aktuellen Session. 

So importieren Sie MIDI-Daten in eine vorhandene 
Spur:

1 Markieren Sie MIDI-Dateien in einem Workspace-
Browser, im Windows Explorer oder Mac Finder. 

2 Ziehen Sie die Dateien auf eine bestehende 
Spur im Edit-Fenster der aktuellen Session. 

So importieren Sie MIDI-Daten in neue Spuren:

1 Markieren Sie MIDI-Dateien in einem Workspace-
Browser, im Windows Explorer oder Mac Finder. 

2 Sie haben folgende Möglichkeiten:

• Halten Sie die Umschalttaste gedrückt, klicken 
Sie auf die Dateien im Workspace-Browser 
und ziehen Sie sie in das Edit-Fenster der 
aktuellen Session.

• Ziehen Sie die Dateien in die Timeline 
der aktuellen Session.

• Ziehen Sie die Dateien in die Tracks-Liste.

Exportieren von MIDI-Dateien
Um die MIDI-Spuren einer Session für die 
Verwendung in einer anderen MIDI-Anwendung 
exportieren oder auf einem externen (Hardware-) 
MIDI-Sequenzer wiedergeben zu können, können 
Sie Pro Tools-MIDI- und Instrumentenspuren 
als Standard-MIDI-Datei exportieren. 

MIDI kann aus Pro Tools in eine zusammengeführte 
Mehrkanalspur (Typ 0) oder als mehrere Spuren 
(Typ 1) exportiert werden.

Wenn in Ihrer Pro Tools-Session Generalvorzeichen 
und Taktarten verwendet werden, werden diese 
mit der MIDI-Datei exportiert.

So exportieren Sie alle MIDI- und 
Instrumentenspuren in der aktuellen Session:

1 Stellen Sie sicher, dass die Stummschaltung für alle 
zu exportierenden MIDI-Spuren in der Session 
deaktiviert ist. (Schalten Sie alle MIDI-Spuren 
stumm, die nicht in die exportierte MIDI-Datei 
aufgenommen werden sollen.) Aktivieren bzw. 
deaktivieren Sie bei Instrumentenspuren die MIDI 
Mute-Option (Instruments-Bedienfeld).

2 Wählen Sie File > Export > MIDI. Das Export 
MIDI Settings-Dialogfeld wird geöffnet.

3 Wählen Sie im MIDI File Format-Popup-Menü 1 

(multitrack) oder 0 (single track).

4 Unterscheidet sich die Song Start- von der 
Session Start-Zeit, wählen Sie im Location 

Reference-Popup-Menü entweder Session 

Start oder Song Start.

Weitere Informationen finden Sie unter 
Kapitel 16: „Workspace-Browser“.

Export MIDI Settings-Dialogfeld
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5 Aktivieren bzw. deaktivieren Sie die Apply 

Real-Time Properties-Option.

6 Klicken Sie auf OK.

7 Geben Sie den Zielordner und den Namen 
für die MIDI-Datei an.

8 Klicken Sie auf Save. 

Pro Tools exportiert alle nicht stummgeschalteten 
MIDI- und Instrumentenspuren in der aktuellen 
Session in eine Standard-MIDI-Datei und speichert 
diese auf der Festplatte. Exportierte MIDI-Daten 
enthalten Noten, Controller-Events, Program 
Changes und systemexklusive Daten sowie Events, 
die Tempo, Taktart und Marker betreffen.

Die SMPTE-Startzeit der Session oder des Songs 
(abhängig von der Auswahl im Location Reference-
Popup-Menü) wird ebenfalls exportiert. Damit wird 
sichergestellt, dass die exportierten Spuren bei der 
Wiedergabe mit einer anderen MIDI-Anwendung 
den korrekten SMPTE-Frames zugeordnet werden 
und korrekt mit Tonband- und Videogeräten oder 
Pro Tools synchronisiert sind.

Schlagen Sie in der jeweiligen Dokumentation des 
Herstellers nach, wenn Sie wissen möchten, ob Ihr 
MIDI-Sequenzer den Import von SMPTE-
Startzeiten aus MIDI-Dateien unterstützt.

Mit MIDI-Dateien nicht exportierte Elemente

Die automatische Stummschaltung und 
stummgeschaltete Clips haben keine Auswirkungen 
auf die exportierten MIDI-Daten. Solange eine 
MIDI- bzw. Instrumentenspur nicht durch Klicken 
auf die entsprechende MIDI Mute-Schaltfläche 
(Instruments-Bedienfeld) stummgeschaltet ist, 
werden alle ihre MIDI-Daten exportiert.

Akkordsymbole und Akkordiagramme hingegen 
werden nicht mit MIDI-Dateien exportiert.

Wenn Sie MIDI-Dateien aus Pro Tools exportieren, 
werden Gerätezuweisungen für Spuren nicht 
beibehalten (Kanalzuweisungen jedoch schon). 
Wenn Sie MIDI- oder Instrumentenspuren aus 
Pro Tools exportieren und sie später wieder 
importieren, müssen Sie die Spuren den Geräten 
in Ihrem Studio erneut zuweisen.

Alle Informationen aus Playlists für MIDI- und 
Instrumentenspuren gehen beim Export verloren. 
Spuren, die beispielsweise vorher Dutzende von 
MIDI-Clips enthielten, umfassen nach dem Export 
und erneuten Import nur noch jeweils einen Clip.

Exportieren von einzelnen MIDI- 
und Instrumentenspuren
Sie können auch einzelne MIDI- und 
Instrumentenspuren als MIDI-Dateien exportieren. 
Dies kann sich als nützlich erweisen, wenn 
Sie Bibliotheken mit Ihren Lieblings-MIDI-
Sequenzen oder -Sysex-Daten (etwa mehrere oder 
einzelne Patch-Dumps für Ihre externen MIDI-
Geräte) speichern oder MIDI in anderen 
Notationsanwendungen als Sibelius importieren.

So exportieren Sie eine einzelne MIDI- oder 
Instrumentenspur als MIDI-Datei:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste auf den 
Spurnamen einer nicht angewählten Spur im Edit- 
oder Mix-Fenster oder in der Tracks-Liste.

• Klicken Sie in der Tracks-Liste oder im Mix- oder 
Edit-Fenster bei gedrückter Strg-Taste (Windows) 
bzw. Befehlstaste (Mac) auf den Spurnamen. 

2 Wählen Sie Export MIDI aus dem Kontextmenü.

3 Legen Sie die Export MIDI-Einstellungen 
im Export MIDI Settings-Dialogfeld fest.

4 Klicken Sie auf OK.

Beim Export von MIDI-Dateien wird 
in Pro Tools automatisch die Erweiterung 
„.mid“ angehängt.
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5 Geben Sie im Save-Dialogfeld einen Namen für 
die MIDI-Datei ein, geben Sie an, wo sie 
gespeichert werden soll, und klicken Sie 
auf Save.

So exportieren Sie alle ausgewählten Pro Tools-
Instrumente oder MIDI-Spuren als MIDI-Datei:

1 Wählen Sie die Spuren aus, die in eine MIDI-
Datei exportiert werden sollen.

2 Klicken Sie mit der rechten Maustaste auf den 
Spurnamen einer angewählten Spur im Edit- 
oder Mix-Fenster oder in der Tracks-Liste.

3 Wählen Sie Export MIDI aus dem Kontextmenü.

4 Legen Sie die Export MIDI-Einstellungen fest.

5 Klicken Sie auf OK. 

6 Geben Sie im Save-Dialogfeld einen Namen für 
die MIDI-Datei ein, geben Sie an, wo sie 
gespeichert werden soll, und klicken Sie 
auf Save.

Exportieren von Sibelius-
Dateien
Mit Pro Tools können Sie die Partitur aus Ihrer 
Session als Sibelius-Datei (.sib) exportieren. 
Sie können die Partitur zur späteren Verwendung 
oder für eine Partiturübertragung als Sibelius-Datei 
exportieren, oder direkt in Sibelius, falls das 
Programm auf Ihrem Computer installiert ist. 
Sibelius verwendet die Pro Tools-Transkription 
von MIDI in Ihrer Session wie im Pro Tools Score 
Editor-Fenster dargestellt (weitere Informationen 
erhalten Sie unter „Exportieren von Partituren“ auf 
Seite 776). 

Importieren von Session-Daten
Mit dem Import Data Session-Befehl oder 
per Drag & Drop können Sie ganze Spuren 
aus anderen Pro Tools-Sessions in eine aktuelle 
Pro Tools-Session importieren. 

Mit Pro Tools können Sie Spuren und bestimmte 
Session-Daten (etwa Automation und Routing) 
importieren. Sie können außerdem Haupt-Playlist-
Optionen importieren und bestehende Optionen 
ersetzen oder Elemente über bestehende Spuren 
legen.

Klicken Sie mit der rechten Maustaste 
bei gedrückter Alt- (Windows) bzw. 
Wahltaste (Mac), um alle Spuren in eine 
einzige MIDI-Datei zu exportieren.

Klicken Sie mit der rechten Maustaste 
bei gedrückter Alt- (Windows) bzw. Wahl- 
(Mac) und Umschalttaste, um alle 
ausgewählten Spuren in eine einzige MIDI-
Datei zu exportieren.

Zum Öffnen von aus Pro Tools exportierten 
SIB-Dateien ist Sibelius 5.x oder 
höher erforderlich.
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So importieren Sie Spuren bzw. deren Attribute:

1 Öffnen oder erstellen Sie eine neue Session.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie File > Import > Session Data, wählen 
Sie die Session, aus der Sie die Daten importieren 
möchten, und klicken Sie auf Open. 

• Ziehen Sie die Session-Datei, deren Spuren bzw. 
Attribute Sie importieren möchten, aus einem 
Workspace-Browser, dem Windows Explorer 
oder Mac Finder an eine leere Stelle des Edit-
Fensters bzw. zur Tracks-Liste.

3 Bei unterschiedlicher Einstellung für die Fader-
Verstärkung (Fader Gain) der Session wird eine 
Aufforderung zum Beibehalten oder Ändern des 
Fader Gain-Werts angezeigt, bevor das Session 
Data-Dialogfeld geöffnet wird.

4 Wählen Sie im Source-Bereich die gewünschten 
Spuren für den Import aus. Klicken Sie dazu auf 
das Popup-Menü rechts neben dem Spurnamen 
und wählen Sie New Track. 

5 Sie können für jede ausgewählte Spur bestimmen, 
ob Sie sie als neue Spur importieren oder eine 
Zielspur im entsprechenden Popup-Menü 
auswählen möchten. Klicken Sie auf Match Tracks, 
um automatisch nach übereinstimmenden 
Ausgangs- und Zielspuren mit demselben Namen 
zu suchen. 

6 Wählen Sie im Track Data to Import-Popup-Menü 
alle zusätzlichen Spurdaten für den Import. 

7 Sie können unter Main Playlist Options 
die Importkonfiguration für die 
Ausgangsspuren festlegen. 

8 Legen Sie gegebenenfalls im Audio Media 

Options- und Video Media Options-Popup-
Menü fest, wie die Mediendateien importiert 
werden sollen. 

9 Wählen Sie für importierte Audiodateien 
die Timecode Mapping Options. 

10 Bei unterschiedlichen Samplerates der Sessions 
wählen Sie im Source Sample Rate-Popup-Menü 
die Samplerate für die Ausgangs-Session aus. 

11 Um die Takt- und Tempozuweisungen aus der 
Ausgangs-Session zu importieren, wählen 
Sie die Import Tempo/Meter Map-Option.

12 Um die Generalvorzeichen aus der Ausgangs-
Session zu importieren, wählen Sie die Import 

Key Signature Map-Option.

13 Um die Marker und Memory Locations aus der 
Ausgangs-Session zu importieren, wählen Sie 
die Import Marker/Memory Locations-Option.

14 Um Fensterkonfigurationen zu importieren, 
wählen Sie die Import Window 

Configurations-Option.

15 In Pro Tools HD können Sie durch Aktivieren 
der Import Mic Pre Settings-Option sämtliche 
Mikrofonvorverstärker-Einstellungen aus 
der Ausgangs-Session importieren.

16 Klicken Sie nach Beendigung des Vorgangs 
auf OK.

17 Wenn Sie Medien kopieren oder zusammenfügen 
möchten, wählen Sie einen Speicherort für die 
Mediendateien aus.

Um mehrere Spuren auszuwählen, klicken Sie 
bei gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac) auf die Popup-Menüs der 
gewünschten Spuren und wählen Sie „Import 
As New Track“.

Wenn das als Ziel gewählte Pro Tools-
System Surround-Mischungen nicht 
unterstützt, werden in der Source Tracks-
Liste keine Surround-Spuren angezeigt.

Wenn die Quellmedien importierter Spuren nicht 
verfügbar sind oder die aktuelle Session keinen 
entsprechenden Ausgangspfad hat, werden diese 
importierten Spuren deaktiviert.
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Importieren von gruppierten 
Playlists aus anderen Sessions
Sie können Spuren mit gruppierten Playlists aus 
einer anderen Pro Tools-Session importieren. Dabei 
bleibt die Gruppierungsfunktion der Playlist für 
diese importierten Spuren erhalten. Der Import aus 
Sessions, die mit früheren Versionen als Pro Tools 
6.1 erstellt wurden, unterliegt jedoch einer 
Beschränkung: Nach dem Importieren eines Teils 
einer gruppierten Playlist (etwa Spuren 1–7 einer 
Gruppe mit 10 Spuren) können die restlichen 
Spuren anschließend nicht importiert und in die 
Playlist-Gruppe mit den Spuren 1–7 aufgenommen 
werden.

Importieren von Sessions und 
Spuren per Drag & Drop
Sie können Session-Dateien in die aktuelle Session 
ziehen und dort ablegen; dadurch werden Audio-, 
Video-, MIDI-, Clipgruppen-, REX- und ACID-
Dateien, Spuren und Session-Daten importiert 
(und positioniert). 

• Durch das Ziehen einer Session in die Clipliste 
werden alle Clips dieser Session importiert 
(ohne die Spuren zu importieren). 

• Durch das Ziehen einer Session in eine Spur in 
Pro Tools können Spuren importiert werden.

• Durch das Ziehen einer Session in eine Spur-
Playlist wird das Import Session Data-Dialogfeld 
geöffnet, in dem Sie die zu importierenden Spuren 
und Attribute auswählen können. Die importierten 
Session-Daten werden an der Stelle eingefügt, an 
der Sie die Session in der Timeline ablegen.

So importieren Sie Spuren und andere Session-
Daten per Drag & Drop:

1 Öffnen Sie einen Workspace-Browser.

2 Ziehen Sie eine Pro Tools-Session-Datei oder 
eine AAF- oder OMF-Sequenz in die aktuelle 
Session. Gehen Sie dazu folgendermaßen vor: 

• Ziehen Sie die Daten auf eine vorhandene Spur, um 
die Daten auf den Zielspuren zu überschreiben. 
Halten Sie während des Ziehvorgangs die 
Umschalttaste gedrückt, um die Playlists der 
aktuelle Spur durch die importierten Playlists zu 
ersetzen (durch die Umschalttaste werden die 
Einstellungen im Import Session Data-Dialogfeld 
automatisch konfiguriert).

• Ziehen Sie die Daten in einen leeren Bereich im 
Edit-Fenster, um neue Spuren für die 
importierten Session-Daten zu erstellen. 

• Konfigurieren Sie die Import Session Data-
Optionen (siehe „Import Session Data-
Dialogfeld“ auf Seite 349). 

Kopieren während des Imports
Ist keine Konvertierung erforderlich und befinden 
sich die Dateien auf einem geeigneten Performance-
Volume, erstellt Pro Tools einen Verweis auf die 
ursprüngliche Version der Medien. Außerdem 
können Sie auch mithilfe von Tastaturbefehlen 
Medien während des Imports kopieren oder die 
Automatically Copy Files on Import-Voreinstellung 
verwenden. Die Kopien werden im Audio Files-
Ordner der Session erstellt. 

So kopieren Sie Dateien manuell beim Import:

 Klicken Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) auf die Dateien. Eine Kopie 
wird im Audio Files-Ordner der Session erstellt. 

Beim Importieren von Sessions oder Spuren können 
Sie im Import Session Data-Dialogfeld angeben, 
ob ein Verweis auf die Quellmedien erstellt oder die 
Quellmedien kopiert werden sollen.
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So werden Dateien automatisch beim Import kopiert:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Wählen Sie Automatically Copy Files on Import. 

3 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

Rückgängigmachen nach 
dem Import 
Mit Undo werden alle in die Timeline importierten 
Dateien wieder daraus entfernt. Die Dateien bleiben 
jedoch in der Session (in der Clipliste und im 
Workspace-Browser) offline. Wenn Sie die Dateien 
nicht manuell aus der Session entfernen oder löschen, 
werden sie von Pro Tools beim nächsten Öffnen der 
Session als fehlende Dateien angezeigt. 

Import Session Data-
Dialogfeld
Im Import Session Data-Dialogfeld können Sie die 
Eigenschaften der Ausgangs-Session anzeigen, die 
zu importierenden Spuren auswählen und in 
Pro Tools HD darüber hinaus bestimmen, welche 
Attribute dieser Spuren Sie in die aktuelle Session 
importieren möchten.

Quelleigenschaften
Im Import Session Data-Dialogfeld werden 
die Eigenschaften der Ausgangs-Session 
angezeigt. Dazu gehören der Name und Typ der 
Ausgangs-Session, die Anfangszeit der Session, 
die Audio-Bitrate und die Samplerate. Bei Sessions 
in Pro Tools 5.1 oder höher werden das 
Programm, in dem die Session erstellt wurde, und 
der Audiodateityp der Session aufgelistet.

Import Session Data-Dialogfeld (Pro Tools HD)
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Textcodierung

Pro Tools ermöglicht überall in der Pro Tools-
Anwendung die Eingabe und Anzeige aller 
Sprachzeichen, die in Unicode unterstützt werden. 
Dadurch können Sie mehrere Sprachen in Session-
Namen sowie in Pfaden, Dateinamen und Clipnamen 
verwenden. 

Pro Tools 7.3.x und frühere Versionen 
unterstützen Unicode jedoch nicht. Für den Import 
von Daten aus Sessions oder OMF-Sequenzen, die 
in älteren Versionen von Pro Tools erstellt oder 
gespeichert wurden, müssen Sie möglicherweise 
die Sprachcodierung der importierten Elemente 
identifizieren. 

So wählen Sie die Sprachcodierung für 
das Importieren von Daten aus einer älteren 
Pro Tools-Session aus:

1 Wählen Sie File > Import Session Data.

2 Wählen Sie im Text Encoding-Popup-Menü die 
Sprache, die in der älteren Session verwendet 
wurde.

Audio Media Options
Die folgenden Audiomedienoptionen sind im 
Import Session Data-Dialogfeld verfügbar:

Link to Source Media (Where Possible) – mit 
dieser Einstellung wird, wenn möglich, auf die 
Originaldateien verwiesen und so das Duplizieren 
von Audiodateien vermieden. Wenn sich die 
Quelldateien nicht auf unterstützten Medien (etwa 
einer CD oder DVD) befinden bzw. die Samplerate 
oder die Bitrate konvertiert werden müssen, werden 
die Ausgangsdateien kopiert. Diese Option 
ermöglicht, dass die aktuelle Session auf Dateien 
verweist, die nicht dem Audiodateiformat der 
aktuellen Session entsprechen. 

Copy from Source Media – mit dieser Option 
werden alle zu den importierten Spuren gehörigen 
Audiodateien vom Quelldatenträger an den neuen 
Speicherort kopiert und bei Bedarf konvertiert, 
sodass sie dasselbe Audiodateiformat, dieselbe 
Bitrate und dieselbe Samplerate wie die aktuelle 
Session aufweisen. Dies ist nützlich, wenn Sie 
Spuren etwa von einer CD oder DVD oder einem 
gemeinsamen Laufwerk kopieren und die 
Audiodateien auf einer anderen Festplatte 
speichern möchten.

Consolidate from Source Media – mit dieser 
Option können Sie Audio während des 
Kopiervorgangs zusammenfügen. Dies ist von 
Vorteil, wenn Sie nur die in den Ausgangsspuren 
verwendeten Clips der Audiodateien kopieren und 
nicht verwendetes Audio ignorieren möchten. Die 
zusammengefügten Audiodaten werden kopiert und 
in das Audiodateiformat, die Bitrate und die 
Samplerate der aktuellen Session konvertiert. 

Wenn Sie diese Option wählen, können Sie auch die 
Handle-Länge (Handle Size) in Millisekunden 
bestimmen, die auf konsolidierte Audiodaten 
angewendet werden soll. Ein Handle ist der Bereich 
der Original-Audiodatei, der vor und nach jedem 
Clip erhalten bleibt, um Bearbeitungen an den neuen 
Clips, wie etwa das Anwenden von Fades oder 
Trimmen, zu ermöglichen.

Force to Target Session Format – mit dieser 
Option werden alle nicht mit dem Audiodateiformat, 
der Bitrate und der Samplerate der aktuellen Session 
übereinstimmenden Dateien konvertiert. Die Dateien, 
die diesen Merkmalen entsprechen, werden direkt 
verwendet und nicht kopiert.

Die Konsolidierung von Quellmedien ist 
beim Importieren von Elastic Audio-Spuren 
nicht verfügbar.
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Video Media Options

Im Import Session Data-Dialogfeld können 
Sie festlegen, ob Videomediendateien entweder an 
ihrem ursprünglichen Speicherort belassen oder an 
eine andere Stelle kopiert werden. Dies ist 
nützlich, wenn Sie Spuren etwa von einer CD, 
einer DVD oder einem gemeinsamen Laufwerk 
kopieren und die Videodateien auf einer anderen 
Festplatte speichern möchten.

Link to Source Media

Wählen Sie diese Option aus, um auf 
Originaldateien zu verweisen und so das 
Duplizieren von Videodateien zu vermeiden. 

Copy from Source Media

Wählen Sie diese Einstellung aus, um alle zu den 
importierten Spuren gehörigen Videodateien vom 
Quelldatenträger an den neuen Speicherort zu 
kopieren. 

Import as Offline Satellite Media

(Nur Pro Tools HD)

Wählen Sie diese Option aus, um Videospuren mit 
Offline-Medien zu importieren. Sie können Schnitte 
und Clipnamen sehen, wobei die Videomediendaten 
offline bleiben. Die Videomediendaten können Sie auf 
einem verbundenen Video Satellite-System anzeigen. 
Diese Option ist nur verfügbar, wenn für die 
Videospur New Satellite Track ausgewählt ist.

Timecode Mapping Options
Im Import Session Data-Dialogfeld können 
Sie festlegen, wo die importierten Spuren in der 
aktuellen Session platziert werden. Die Zeit wird 
im Timecode angezeigt.

Folgende Timecode-Zuordnungsoptionen 
(Timecode Mapping Options) stehen zur Verfügung:

Maintain Absolute Timecode Values Bei Auswahl 
dieser Option werden die Spuren an der Stelle 
positioniert, an der sie sich in der ursprünglichen 
Session befanden. Wenn Ihre Session also 

bei 00:01:00:00 und die Export-Session bei 
10:00:00:00 beginnt, können die importierten 
Spuren frühestens 9 Stunden und 59 Minuten nach 
Beginn der Session darin erscheinen.

Maintain Relative Timecode Values Bei Auswahl 
dieser Option werden die Spuren an derselben 
Stelle in Bezug zum Anfangspunkt 
der ursprünglichen Session positioniert. Wenn die 
Ausgangs-Session etwa bei 01:00:00:00 beginnt 
und eine Spur mit Beginn bei 01:01:00:00 enthält, 
die aktuelle Session jedoch bei 02:00:00:00 startet, 
wird die Spur bei 02:01:00:00 in die aktuelle 
Session eingefügt. 

Map Start Timecode To Mit dieser Option 
platzieren Sie die Spuren relativ zur Startzeit 
der Original-Session. Zeitangaben im Format 
hh:mm:ss:ff angegeben. Wenn Ihre Session also 
beispielsweise bei 00:01:00:00 und die Export-
Session bei 10:00:00:00 beginnt, können Sie den 
Start-Timecode auf 00:01:00:00 stellen, um zu 
vermeiden, dass Dateien 9 Stunden und 59 Minuten 
nach Beginn der Session eingefügt werden.

Adjust Session Start Time to Match Source 
Start Time

Wenn diese Option aktiviert ist, wird die Startzeit 
der aktuellen Pro Tools-Session automatisch 
an die Startzeit der importieren Session, 
AAF- oder OMF-Sequenz angeglichen. 

Track Offset Options
Im Import Session Data-Dialogfeld können 
Sie zusätzlich zu den durch die Timecode Mapping 

Options festgelegten Verschiebungen eine weitere 
zeitliche Verschiebung der Spuren angeben. Alle 
importierten Audiodaten werden in der Timeline 
der aktuellen Session um den angegebenen Wert 
verschoben. Sie können die Werte in 
Minuten:Sekunden, Bars|Beats, Samples, 
Timecode oder Feet/Frames angeben. 
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Sample Rate Conversion 
(SRC) Options
Im Import Session Data-Dialogfeld können Sie unter 
die Samplerate-Konvertierung für importierte 
Audiodateien festlegen. Wenn die Ausgangs- und 
Ziel-Session dieselbe Samplerate aufweisen, ist dieser 
Teil des Dialogfelds nicht verfügbar.

Folgende Sample Rate Conversion Options stehen 
zur Verfügung:

Source Sample Rate – es stehen bei der 
Samplerate-Konvertierung verschiedene Verfahren 
zur Verfügung, die auf Audiodateien aus einer 
beliebigen Session, ganz unabhängig von deren 
Samplerate, angewendet werden können, um Pullup-, 
Pulldown- und NTSC- oder PAL-Framerates 
auszugleichen. Über diese Einstellung können Sie 
auswählen, aus welcher Samplerate die 
Konvertierung vorgenommen werden soll. 

Destination Sample Rate – die Ziel-Samplerate 
entspricht immer der Samplerate Ihrer aktuellen 
Session.

Conversion Quality – hier können Sie die Qualität 
für die Samplerate-Konvertierung einstellen (siehe 
„Qualität der Samplerate-Konvertierung“ auf 
Seite 327).

Quellspuren
Der Bereich „Source Tracks“ des Dialogfelds 
enthält eine Liste der importierbaren Spuren in der 
Ausgangs-Session mit den dazugehörigen Popup-
Menüs. 

Operation/Destination Track-
Popup-Menüs
Im Import Session Data-Dialogfeld verfügt jede 
Ausgangsspur über ein eigenes Popup-Menü 
mit einer Auflistung der Importoptionen und 
eventuellen Zielspuren in der aktuellen Session. 
Im Popup-Menü werden die folgenden 
Elemente angezeigt:

Do Not Import – weder die Ausgangsspur noch 
die dazugehörigen Attribute werden importiert. 

Import as New Track – die Ausgangsspur und alle 
im Track Data to Import-Popup-Menü ausgewählten 
Daten werden in eine neue Spur der aktuellen 
Session importiert. 

Destination Track Names – die Namen von 
eventuell geeigneten Zielspuren der aktuellen 
Session werden am unteren Ende des Popup-
Menüs angezeigt. Die importierten Playlists sowie 
alle im Track Data to Import-Popup-Menü 
festgelegten Daten werden in die ausgewählte 
Zielspur importiert. 

Nur mit der Spurart (Audio, Instrument, 
MIDI, Auxiliary-Eingang oder Master-Fader) 
und dem Kanalformat (Mono, Stereo oder 
einem der unterstützten Mehrkanalformate) 
der Ausgangsspur übereinstimmende Zielspuren 
werden im Popup-Menü angezeigt. 

Matching Tracks
Im Import Session Data-Dialogfeld können 
Sie sicherstellen, dass Spurnamen beim 
Importieren von Playlists von Ausgangsspuren mit 
demselben Namen wie die Zielspuren in 
der aktuellen Session übereinstimmen (etwa als 
neuer Schnitt einer Szene). Klicken Sie 
auf Matching Tracks, um automatisch nach 
übereinstimmenden Spurnamen zu suchen. Dazu 
müssen die Spuren denselben Namen, dieselbe 
Spurart und dasselbe Kanalformat aufweisen.

Track Data to Import
Im Track Data to Import-Popup-Menü des Import 
Session Data-Dialogfelds können Sie die Attribute 
ausgewählter Spuren bestimmen, die Sie in die 
aktuelle Session importieren möchten. 

Die ausgewählten Attribute werden für alle Spuren 
übernommen, die in die aktuelle Session importiert 
werden sollen.
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Ersetzen von Spurattributen

Beim Importieren eines Attributs einer 
Ausgangsspur in eine bestehende Spur wird 
das entsprechende Attribut in der Zielspur dadurch 
ersetzt. Wenn Sie das Attribut nicht importieren, 
bleibt das entsprechende Attribut der Zielspur 
erhalten. 

Ersetzen von Spurpfadnamen

Beim Importieren der Eingangs-, Ausgangs-, Send-
Ausgangs- oder Hardware-Insert-Zuweisungen 
werden benutzerdefinierte Pfadnamen und I/O-
Konfigurationen aus der Ausgangs-Session nicht 
importiert. Pfadnamen und I/O-Konfigurationen 
können durch Importieren der I/O Setup-Einstellungen 
übertragen werden. Weitere Informationen finden Sie 
unter „Werkseitige I/O-Einstellungen“ auf Seite 100. 

Auswählen von Spurdaten für den Import

Sie können All, None oder eine beliebige 
Kombination aus allen aufgelisteten Attributen 
auswählen. Die folgenden Spurdaten können 
importiert werden:

All – importiert alle Playlists der Ausgangsspur, 
die unter Main Playlist Options festgelegt wurden, 
sowie alle Attribute in der Track Data to Import-
Liste.

None – importiert gemäß der Festlegung unter 
Main Playlist Options ausschließlich die Haupt-
Playlist der Ausgangsspur. 

Alternate Playlists – importiert alle alternativen 
Playlists der Ausgangsspur. Die alternativen 
Playlists werden im Playlist-Popup-Menü 
der Zielspur angezeigt. 

Clips and Media – importiert alle Audiodateien 
oder Clips der Ausgangsspur und platziert 
sie in die Clipliste. 

Clips Gain – importiert die Clip-Gain-
Einstellungen für alle importierten Audioclips. 

Volume Automation and Setting – importiert 
die Einstellung vom Volume-Fader der 
Ausgangsspur und alle in der Volume Automation-
Playlist festgelegten Automationsdaten der Spur. Die 
entsprechenden Einstellungen und Daten 
der Zielspur werden durch den Import ersetzt. 

Pan Automation and Setting – importiert die 
Einstellung des Panoramareglers der 
Ausgangsspuren und alle in der Pan Automation-
Playlist festgelegten Automationsdaten der Spur. Die 
entsprechenden Einstellungen und Daten 
der Zielspur werden durch den Import ersetzt.

Mute Automation and Setting – importiert 
die Mute-Einstellung der Ausgangsspur und alle 
in der Mute-Automation-Playlist festgelegten 
Automationsdaten der Spur. Die entsprechenden 
Einstellungen und Daten der Zielspur werden 
durch den Import ersetzt.

Main Output Assignments – importiert die 
Kanalausgangszuweisungen der Ausgangsspur, 
einschließlich mehrfacher Ausgangszuweisungen. 
Die Kanalausgangszuweisungen der Zielspur 
werden durch den Import ersetzt.

Send Output Assignments – importiert die Send-
Ausgangszuweisungen der Spur. Die Send-
Ausgangszuweisungen der Zielspur werden durch 
den Import ersetzt.

Plug-In Assignments – importiert die Plug-In-
Ausgangszuweisungen der Spur. Alle Plug-Ins und 
die dazugehörigen Einstellungen und 
Automationsdaten in der Zielspur werden entfernt. 

Wenn in der Ausgangsspur ein Plug-In verwendet 
wird, das auf dem Zielsystem nicht verfügbar ist, 
wird es in der Zielspur angezeigt und deaktiviert. 

Plug-In Settings and Automation – beim 
Importieren der Plug-In-Zuweisungen 
der Ausgangsspur werden mithilfe dieser Option 
auch die dazugehörigen Plug-In-Einstellungen und 
Automationsdaten importiert. Diese Option hat 
keine Wirkung, wenn keine Plug-In-Zuweisungen 
importiert werden.
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Elastic Audio Track State – importiert den Elastic 
Audio-Spur-Status der Spur. Alle Elastic Audio-
Einstellungen in der Ziel-Session werden ersetzt.

HW Insert Assignments – importiert die 
Hardware-Insert-Zuweisungen der Spur. 
Die Insert-Ausgangszuweisungen der Zielspur 
werden durch den Import ersetzt.

Voice Assignments – importiert die Voice-
Zuweisung der Ausgangsspur aus der Ausgangs-
Session. Alle Voice-Zuweisungen der Zielspur 
werden ersetzt. 

Input Assignments – importiert die 
Kanaleingangszuweisung der Spur. Die 
Eingangszuweisungen der Zielspur werden durch 
den Import ersetzt. 

Side-Chain Assignments – beim Importieren 
der Plug-In-Zuweisungen der Ausgangsspur werden 
mithilfe dieser Option auch eventuell vorhandene 
Sidechain-Zuweisungen importiert. Diese Option hat 
keine Wirkung, wenn keine Plug-In-Zuweisungen 
importiert werden.

Track Active State – importiert den Status 
aktiv/inaktiv der Ausgangsspur aus der Ausgangs-
Session.

Track Comments – importiert alle mit der 
Ausgangsspur verbundenen Anmerkungen. 
Die Anmerkungen in der Zielspur werden durch 
den Import ersetzt. 

Track Colors – importiert die mit der Ausgangsspur 
verbundene Spurfarbe. Alle Farben für die Zielspur 
werden geändert. 

Record Safe/Solo Safe Settings – importiert die 
Record Safe- und Safe Record-Einstellungen der 
Ausgangsspuren aus der Ausgangs-Session. Alle 
Record Safe- und Safe Record-Einstellungen 
der Zielspur werden ersetzt. 

Track View Settings – importiert die 
Darstellungshöhe und Playlists-Darstellung 
der Ausgangsspur aus der Ausgangs-Session. 

Mix/Edit Groups – importiert Spurgruppen aus der 
Ausgangs-Session.

ICON Custom Fader Groups (nur Pro Tools HD) 
– importiert alle ICON Custom Fader-Gruppen aus 
der Ausgangs-Session.

ICON Automation Snapshots (nur Pro Tools HD) – 
importiert alle ICON-Automation-Schnappschüsse 
aus der Ausgangs-Session.

HEAT Switch Settings (nur Pro Tools|HDX-
Systeme mit HEAT Software-Option) – importiert 
alle gespeicherten HEAT Switch-Einstellungen 
aus der Ausgangs-Session.

Importoptionen
Die folgenden Importoptionen sind im Import 
Session Data-Dialogfeld verfügbar:

Import Tempo/Meter Map. – importiert die in 
den Dirigenten-Leisten „Tempo“ und „Meter“ 
angezeigten Takt- und Tempozuweisungen aus der 
Ausgangs-Session. Alle Tempo- und Meter-Events 
in den Zielspuren werden ersetzt. 

Import Key Signature/Chord Map. – importiert alle 
Generalvorzeichen (falls vorhanden) und Akkord-
Marker mit den Session-Daten in Pro Tools. Alle 
in der Ziel-Session vorhandenen Generalvorzeichen 
und Akkord-Marker werden ersetzt.

Import Marker/Memory Locations. – importiert 
Marker und Memory Locations, wie sie in der 
Marker-Leiste angezeigt werden, aus der Ausgangs-
Session. Etwaige in der Ziel-Session enthaltene 
Marker und Memory Locations bleiben erhalten. 
Importierten Markern und Memory Locations 
werden die nächsten verfügbaren Marker/Memory 
Location-Nummern zugewiesen.

Import Window Configurations. 

Import Mic Pre Settings – importiert alle 
Pro Tools-Voreinstellungen für den 
Mikrofonvorverstärker aus der Ausgangs-Session. 
Alle Mikrofonvorverstärker-Einstellungen in der 
Ziel-Session werden ersetzt. 
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Import HEAT Master Settings (nur Pro Tools|HDX 
mit HEAT) – importiert alle HEAT Master-
Einstellungen aus der Ausgangs-Session, 
einschließlich der Einstellungen für „Bypass“, 
„Drive“ und „Tone“. Alle HEAT Master-
Einstellungen in der Ziel-Session werden ersetzt.

Main Playlist Options
Die folgenden Optionen im Import Session Data-
Dialogfeld legen die Parameter für den Import der 
Haupt-Playlist aller Ausgangsspuren in die 
Zielspur der aktuellen Session fest. 

Import – Replace Existing Playlists – importiert 
die Haupt-Playlist der Ausgangsspur. Beim 
Importieren der Playlist in eine bestehende Spur 
wird die Haupt-Playlist der Zielspur durch die 
importierte Playlist ersetzt. 

 Wenn Sie diese Option aktivieren und alle 
Attribute der Ausgangsspur importieren, 
entspricht dies dem Import der gesamten Spur. 

 Wenn Sie diese Option aktivieren und keine 
Attribute der Ausgangsspur importieren, wird die 
Audio-Playlist zwar ersetzt, die aktuellen 
Mischereinstellungen bleiben jedoch erhalten.

Import – Overlay New On Existing Playlists – 
importiert die Haupt-Playlist der Ausgangsspur. 
Beim Importieren der Playlist in eine bestehende 
Spur werden eventuelle Überschneidungen 
vorhandener Daten mit den neuen Daten getrimmt 
und durch die importierten Informationen ersetzt. 
Die Playlist-Daten in der Zielspur, die sich nicht 
mit den importierten Daten überschneiden, bleiben 
erhalten. 

Do Not Import – die Haupt-Playlist der 
Ausgangsspur wird nicht importiert. Anstelle der 
Audiodaten werden lediglich die in der Track Data to 

Import-Liste ausgewählten Attribute importiert. 
Wenn Sie diese Option wählen und alle Eingangs-, 
Ausgangs-, Send-, Insert- und Plug-In-Attribute der 
Ausgangsspur importieren, kommt dies dem Import 
eines Kanalzugs gleich.

Importieren von AAF- und 
OMF-Sequenzen
Mit Pro Tools können Sie AAF- und OMF-Sequenzen 
als neue Pro Tools-Sessions öffnen oder AAF- und 
OMF-Sequenzen in vorhandene Pro Tools-Sessions 
importieren. Pro Tools kann aus anderen Pro Tools-
Sessions, aus Avid Media Composer oder aus 
Anwendungen von Drittanbietern (etwa Final Cut Pro, 
Logic Audio, Adobe Premiere Pro und Nuendo) 
exportierte AAF- und OMF-Sequenzen importieren.

Beim Import von AAF-Sequenzen, die in einer 
Videobearbeitungsanwendung von Avid erstellt 
wurden, kann Pro Tools Mono-, Stereo- und 5.1- 
sowie 7.1-Surround-Audiospuren importieren. 
Monospuren mit 5.1- oder 7.1-Surround-Panning 
können ebenfalls importiert werden, vorausgesetzt, 
die Informationen zum Mehrkanal-Panning sind 
unverändert erhalten. (Mehrkanalformate werden nur 
bei Pro Tools HD unterstützt.)

Beim Öffnen und Importieren von AAF- oder OMF-
Sequenzen wird das New Session-Dialogfeld 
geöffnet. Sie werden aufgefordert, einen Namen 
einzugeben und die Sequenz als neue Session zu 
speichern. Nachdem Sie die neue Session benannt 
und gespeichert haben, wird das Import Session 
Data-Dialogfeld geöffnet. Weitere Informationen 
finden Sie unter „AAF/OMF-Quellspur-
Umwandlungseinstellungen“ auf Seite 363.

Sie können die folgenden Dateitypen aus Avid-
Bearbeitungsprogrammen in Pro Tools importieren:

• AAF- oder OMF-Sequenzen (einschließlich 
derer mit eingebettetem Audio)

• einzelne Avid-Video-Dateien im MXF- oder 
OMF-Format

• OMF- und MXF-Audiodateien

Der Mehrkanal-Import und -Export ist nur mit 
AAF-Sequenzen möglich.

Avid Mojo SDI oder Avid Mojo ist für den Import 
von MXF- und OMF-Video erforderlich.
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So importieren Sie AAF- oder OMF-Sequenzen in 
Pro Tools:

 Wählen Sie File > Import > Session Data.

 Wählen Sie File > Open Session.

 Ziehen Sie die Dateien aus einem beliebigen 
Workspace-Browser oder vom Desktop und 
legen Sie sie ab.

So importieren Sie einzelne Avid MXF- oder OMF-
Videodateien in Pro Tools:

 Wählen Sie File > Import > Video.

 Ziehen Sie die Dateien aus einem beliebigen 
Workspace-Browser oder vom Desktop und 
legen Sie sie ab.

So importieren Sie einzelne OMF- oder MXF-
Audiodateien in Pro Tools:

 Wählen Sie File > Import > Audio.

 Ziehen Sie die Dateien aus einem beliebigen 
Workspace-Browser oder vom Desktop und 
legen Sie sie ab.

Importieren einer AAF- oder OMF-
Sequenz als Pro Tools-Session
Aus einer Avid-Anwendung wie etwa Media 
Composer exportierte Sequenzen lassen sich in 
Pro Tools am einfachsten bearbeiten, indem sie als 
neue Session geöffnet werden.

So öffnen und importieren Sie eine AAF- oder 
OMF-Sequenz in Pro Tools:

1 Starten Sie Pro Tools.

2 Wählen Sie File > Open Session.

3 Navigieren Sie im Open Session-Dialogfeld 
zur AAF- oder OMF-Sequenz, die Sie 
importieren möchten.

4 Klicken Sie auf Open.

5 Wählen Sie Audio File Type, Sample Rate und 
Bit Depth für die Session.

6 Wählen Sie Interleaved aus, um Mehrkanal-
Interleaved-Audiodateien in der Session 
zu erstellen.

7 Klicken Sie auf OK.

8 Benennen Sie die Session im Save As-Feld.

9 Klicken Sie auf Save. Das Import Session Data-
Dialogfeld wird geöffnet.

Weitere Informationen finden Sie unter 
„Importieren einer AAF- oder OMF-
Sequenz in eine vorhandene Session“ auf 
Seite 358.

In Pro Tools können keine Videodateien 
abgespielt werden, wenn diese in eine AAF- 
oder OMF-Sequenz eingebettet wurden.

Sie können OMF- oder AAF-Sequenzen öffnen und 
importieren, die auf Audiodateien mit gemischten 
Samplerates oder Bitrates verweisen.

Import Session Data-Dialogfeld
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10 Wählen Sie im Audio Media Options-Popup-Menü 
eine Option zum Importieren von Audio aus (siehe 
„Audiomedien-Optionen“ auf Seite 360).

11 Wählen Sie im Video Media Options-Popup-Menü 
eine Option zum Importieren von Video aus (siehe 
„Videomedien-Optionen“ auf Seite 361).

12 Passen Sie bei Bedarf weitere Einstellungen 
und Optionen an (siehe „Importoptionen für 
AAF- oder OMF-Sequenzen“ auf Seite 360). 

13 Klicken Sie auf OK.

Pro Tools erstellt an dem von Ihnen festgelegten 
Speicherort eine neue Session-Datei sowie die 
folgenden Elemente:

• Audio Files-Ordner

• Clip Groups-Ordner

• Session File Backups-Ordner 

• Video Files-Ordner

• cache.wfm-Datei

Diese Session stimmt mit dem Audiodateityp, der 
Samplerate und der Bitrate des Audiomaterials im 
ausgewählten OMF oder AAF überein. Pro Tools 
importiert kein in eine Sequenz eingebettetes Video. 

Wenn ein Video Satellite-System verfügbar ist, kann 
Pro Tools die Video-Metadaten einer Sequenz in eine 
Satellite-Spur importieren. In diesem Fall wird das 
Video parallel zur Pro Tools-Wiedergabe vom Video 
Satellite-Gerät wiedergegeben.

Multicam-Auflösungsdateien

Auf einem Avid-System stellen Multicam-
Auflösungsdateien mehrere unterschiedliche 
Kameraperspektiven einer Szene dar. Der Avid-
Anwender bestimmt beim Exportieren im AAF- oder 
OMF-Format, welche der Multicam-Dateien (d. h. 
Perspektiven) Vorrang haben soll. Wenn Sie eine 
AAF- oder OMF-Sequenz in eine Pro Tools-Session 
importieren, wird nur der Clip mit der vorrangigen 
Kameraperspektive angezeigt.

Weitere Informationen finden Sie unter 
Kapitel 55: „Avid Video Satellite“.

Sollte es während des Importvorgangs zu 
Fehlern, abgeschnittenen Clipnamen oder 
sonstigen Hinweisen (etwa nicht gerenderten 
Effekten) kommen, wird ein Dialogfeld 
eingeblendet, über das Sie einen detaillierten 
Bericht der Änderungen aufrufen können. 
Klicken Sie auf „Yes“ und wählen Sie den Pfad 
für das Protokoll aus. Bei dem Protokoll 
handelt es sich um eine Textdatei, die mit jeder 
beliebigen Textverarbeitungsanwendung 
geöffnet werden kann.

Jede AAF- und OMF-Datei verfügt über einen 
Dateinamen und eine eindeutige Kennung, die 
in den AAF- oder OMF-Metadaten gespeichert 
werden, sowie über einen auf dem Desktop 
angezeigten Namen. Wird während der 
Umwandlung ein Clipname abgeschnitten, 
hat dies keinen Einfluss auf den Namen 
der AAF- bzw. OMF-Datei oder auf die 
eindeutige Kennung.
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Importieren einer AAF- oder 
OMF-Sequenz in eine 
vorhandene Session
Sie können eine AAF- oder OMF-Sequenz mit 
Audio- und Videomedien in eine vorhandene 
Pro Tools-Session importieren. 

So öffnen und importieren Sie Audio- und/oder 
Videospuren aus einer OMF- oder AAF-Sequenz:

1 Starten Sie Pro Tools und öffnen Sie eine 
vorhandene Pro Tools-Session.

2 Wählen Sie File > Import > Session Data und 
wählen Sie die zu importierende AAF- oder 
OMF-Sequenz.

3 Deaktivieren Sie im Import Session Data-
Dialogfeld die Ausgangsspuren, die nicht 
importiert werden sollen (Wenn Sie Session-
Daten aus AAF- oder OMF-Sequenzen 
importieren, werden standardmäßig alle Spuren 
ausgewählt; wenn Sie hingegen Spuren aus einer 
Pro Tools-Session importieren, werden 
standardmäßig keine Spuren ausgewählt.)

4 Wählen Sie die AAF-/OMF-
Umwandlungseinstellungen (siehe 
„AAF/OMF-Quellspur-
Umwandlungseinstellungen“ auf Seite 363).

5 Wählen Sie die Audio Media Options (siehe 
„Audiomedien-Optionen“ auf Seite 360).

6 Wählen Sie die Video Media Options (siehe 
„Videomedien-Optionen“ auf Seite 361).

7 Wählen Sie die Timecode Mapping Options 
(siehe „Timecode-Zuordnungsoptionen“ auf 
Seite 361).

8 Wählen Sie die Track Offset Options (siehe 
„Spur-Offset-Optionen“ auf Seite 362).

9 Wählen Sie die Sample Rate Conversion 

Options (siehe „Samplerate-
Konvertierungsoptionen“ auf Seite 362).

10 Passen Sie bei Bedarf weitere Einstellungen und 
Optionen an (weitere Informationen zum Import 
Session Data-Dialogfeld finden Sie unter „Import 
Session Data-Dialogfeld“ auf Seite 349). 

11 Klicken Sie auf OK.

12 Befinden sich Ihre Audio- oder Video-Quellmedien 
auf einem Volume, das sich nicht zur Wiedergabe 
eignet (im Arbeitsbereich-Browser als Transfer-
Volume angezeigt), weist Sie Pro Tools in einem 
Dialogfeld an, die Medien auf ein für die 
Wiedergabe oder Aufnahme bestimmtes Volume zu 
kopieren. Klicken Sie auf Yes.

Pro Tools importiert die Audio- und Videomedien in 
die Timeline. Audiospuren mit gemischten 
Samplerates werden automatisch in die Samplerate 
der Session konvertiert.

Sie können eine AAF- oder OMF-Sequenz auch 
per Drag & Drop aus einem Speicherort auf 
Ihrem Computer oder aus dem Workspace-
Browser in der Pro Tools-Timeline öffnen.

Quellspuren

Sollte es zu Fehlern oder abgeschnittenen 
Clipnamen kommen, erscheint ein Dialogfeld, 
über das Sie einen detaillierten Bericht der 
Änderungen aufrufen können. Klicken Sie auf 
„Yes“ und wählen Sie den Pfad für das 
Protokoll aus.
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Importieren von AAF- oder OMF-
Audiosequenzen mit gemischten 
Samplerates oder Bitrates
Sie können AAF- oder OMF-Sequenzen mit 
gemischten Samplerates und Bitrates in Pro Tools 
öffnen und importieren.

Audiodateien, die nicht dieselbe Samplerate wie die 
Session aufweisen, müssen konvertiert werden, um 
mit der Session verwendet werden zu können. Beim 
Konvertieren einer Audiodatei wird eine neue Datei 
mit dem richtigen Dateityp und der korrekten 
Samplerate erstellt und im gewünschten Ordner 
gespeichert. Audiodateien mit unterschiedlichen 
Bitrates (aber übereinstimmenden Samplerates) 
können ohne Konvertierung importiert werden.

Importieren von Audiomaterial 
aus AAF-Sequenzen mit nicht 
unterstützten Videoformaten
Mit Pro Tools können Sie Audiomaterial aus 
AAF-Sequenzen importieren, die nicht 
unterstützte Videoformate enthalten, 
einschließlich Avid-HD-Videodateien mit 
Framerates von über 30 Frames pro Sekunde.

Beim Importieren von AAF-Sequenzen dieses 
Typs gelten die folgenden Regeln:

• Unterstütztes Audiomaterial in diesen 
Sequenzen wird wiedergeben, nicht 
unterstütztes Videomaterial dagegen nicht.

• Nicht unterstütztes Videomaterial wird in der 
Timeline durch orangefarbene Blöcke dargestellt.

Importieren von AAF- oder OMF-
Sequenzen mit Medien-Mixdowns
Mit Pro Tools in Kombination mit Avid-
Videoperipherie können Sie aus Avid-Editing-
Anwendungen exportierte AAF- und OMF-
Sequenzen importieren, indem Sie File > Import > 

Session Data wählen oder die Sequenzen vom 
Desktop oder aus einem Workspace-Browser ziehen 
und in Pro Tools ablegen. Weitere Informationen 
finden Sie unter „Importieren von Session-Daten“ 
auf Seite 346. 

Enthält die Sequenz einen Video-Mixdown, 
werden dieser und die dazugehörigen Metadaten in 
der Timeline in zwei verschiedenen Videospuren 
angezeigt.

Enthält die Sequenz einen Audio-Mixdown, 
werden dieser und die dazugehörigen Metadaten in 
der Timeline in zwei verschiedenen Videospuren 
angezeigt.

Sie können anhand der Source Sample Rate-
Einstellungen alle Pull Up- oder Pull Down-
Faktoren ausgleichen, die möglicherweise vor 
dem Import auf das Audiomaterial angewendet 
wurden. Stellen Sie in Sequenzen mit Dateien 
gemischter Samplerates die Ausgangs-
Samplerate proportional zur Ziel-Samplerate 
der Session ein. Der Pull Up- oder Pull Down-
Ausgleich wird dann auf alle Dateien im 
Verhältnis zu ihrer ursprünglichen Samplerate 
korrekt angewendet.
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Importoptionen für AAF- oder 
OMF-Sequenzen
Beim Importieren von AAF- oder OMF-Sequenzen 
stellt Pro Tools im Import Session Data-Dialogfeld 
folgende Importoptionen zur Verfügung:

• Audiomedien-Optionen

• Videomedien-Optionen

• Timecode-Zuordnungsoptionen

• Spur-Offset-Optionen

• Samplerate-Konvertierungs-Optionen

• AAF/OMF-Quellspur-
Umwandlungseinstellungen

• Optionen für die Haupt-Playlist

Audiomedien-Optionen
Verwenden Sie beim Importieren von AAF- oder 
OMF-Spuren in Pro Tools das Audio Media Options-
Popup-Menü zum Kopieren, Konsolidieren oder 
Verweisen auf die Quell-Audiomedien.

Link to Source Audio Media (Where Possible)

Mit dieser Option können Sie die AAF- oder 
OMF-Datei in eine Pro Tools-Session umwandeln, 
die auf so viele ursprüngliche Mediendateien wie 
möglich verweist. In diesem Fall verweist die 
Pro Tools-Session auf die BWF- (WAV-) oder 
AIF-Dateien des Quellprojekts. 

Beim Importieren von Audiomaterial, das in eine 
AAF-Sequenz eingebettet ist, kopiert Pro Tools 
das Audiomaterial auf ein neues Laufwerk oder in 
einen neuen Ordner, auch wenn diese Einstellung 
ausgewählt ist.

Copy from Source Media

Wenn Sie diese Einstellung wählen, wird das 
referenzierte Audiomaterial auf ein neues 
Laufwerk oder in einen neuen Ordner kopiert. 

Sie können die Samplerate-Konvertierung des 
Audiomaterials während dieser Übertragung 
vornehmen.

OMFI-Audiodateien und der Copy from Source 
Media-Modus

Wenn Sie beim Import von AAF- oder OMF-
Sequenzen die Copy from Source Media-Option 
aktiveren, kann Pro Tools WAV- und AIF-
Audiodateien im OMFI-Format direkt in die Session 
kopieren. OMFI-Audiodateien werden in Pro Tools 
jedoch als schreibgeschützte Dateien behandelt. 

Entsprechend können destruktive Bearbeitungen 
und Vorgänge (wie die Bearbeitung mit dem 
Pencil-Tool) für diese Dateien nicht angewendet 
werden, solange sie vorher nicht in Standard-
Audiodateien konvertiert wurden.

So konvertieren Sie OMFI-Audiodateien während 
des Imports:

 Wählen Sie bei der Einstellung der Import-
Optionen statt des Copy from Source Media-
Modus den Force to Target Format-Modus. 
Weitere Informationen finden Sie unter „Force 
to Target Session Format“ auf Seite 361. 

So konvertieren Sie eine in der aktuellen Session 
vorhandene OMFI-Audiodatei:

1 Wählen Sie die Audiodatei(en) aus, die 
konvertiert werden soll(en).

2 Verwenden Sie den Consolidate-Befehl (Edit > 

Consolidate Clip), um die ausgewählte(n) 
Audiodatei(en) zu konvertieren.

3 Bearbeiten Sie Ihre neu konvertierten Dateien 
anschließend wie gewohnt.

Consolidate from Source Media

Verwenden Sie diese Einstellung, um das 
Audiomaterial vom Quellprojekt in die Pro Tools-
Session zu kopieren und dabei alle nicht 
verwendeten Bereiche in den Kopien zu löschen. 
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Es kann etwa vorkommen, dass Sie in Ihrem 
Projekt nur zehn Sekunden einer zehn Minuten 
langen Audiodatei verwenden. Das Konsolidieren 
dieser Audiodatei spart erheblichen Speicherplatz, 
da das verwendete Audiomaterial zusammen mit 
einem vom Anwender festgelegten Handle 
behalten wird, während der Rest verworfen wird.

Sie können die Samplerate-Konvertierung 
des Audiomaterials während der 
Übertragung vornehmen.

Force to Target Session Format

Verwenden Sie diese Einstellung, um 
Ausgangsmedien in das Audiodateiformat der 
Session umzuwandeln, wenn das Dateiformat der 
Ausgangsmedien von dem der Session abweicht.

Handle-Länge (Millisekunden)

Ist die Consolidate from Source Media-Option 
aktiviert, können Sie angeben, wie viele 
Millisekunden für jede ursprüngliche Audiodatei 
vor und nach den im Quellprojekt festgelegten 
Clipgrenzen beibehalten werden sollen. Dadurch 
können Sie die Clipgrenzen auch nach der 
Konsolidierung um die gewünschte Länge nach 
hinten verschieben.

Ein Handle von mindestens 1000 Millisekunden ist 
empfehlenswert, damit Sie übersteuertes oder 
zerstückeltes Material „heraustrimmen“ können.

Videomedien-Optionen
Verwenden Sie beim Importieren von AAF- oder 
OMF-Spuren in Pro Tools das Video Media 
Options-Popup-Menü zum Kopieren oder 
Verweisen auf die Quell-Audiomedien.

Link to Source Media

Wählen Sie diese Option aus, um auf 
Originaldateien zu verweisen und so das 
Duplizieren von Videodateien zu vermeiden. 

Copy from Source Media

Wählen Sie diese Einstellung aus, um alle zu den 
importierten Spuren gehörigen Videodateien vom 
Quelldatenträger an den neuen Speicherort zu 
kopieren. 

Import as Offline Satellite Media

(Nur Pro Tools HD)

Wählen Sie diese Option aus, um Videospuren mit 
Offline-Medien zu importieren. Sie können Schnitte 
und Clipnamen sehen, wobei die Videomediendaten 
offline bleiben. Die Videomediendaten können Sie auf 
dem verbundenen Video Satellite-System anzeigen. 
Diese Option ist nur verfügbar, wenn für die 
Videospur New Satellite Track ausgewählt ist.

Timecode-Zuordnungsoptionen
Beim Importieren von AAF- oder OMF-Spuren in 
Pro Tools können Sie festlegen, wo die importierten 
Spuren in der aktuellen Session platziert werden. Die 
Zeit wird im Timecode angezeigt.

Maintain Absolute Timecode Values

Bei Auswahl dieser Option werden die Spuren an der 
Stelle positioniert, an der sie sich in der 
ursprünglichen Session befanden. Wenn Ihre Session 
also bei 00:01:00:00 und die Export-Session bei 
10:00:00:00 beginnt, können die importierten Spuren 
frühestens 9 Stunden und 59 Minuten nach Beginn 
der Session darin erscheinen.

Maintain Relative Timecode Values

Bei Auswahl dieser Option werden die Spuren an 
derselben Stelle in Bezug zum Anfangspunkt der 
ursprünglichen Session positioniert. Wenn die 
Ausgangs-Session etwa bei 01:00:00:00 beginnt 
und eine Spur mit Beginn um 01:01:00:00 enthält, 
die aktuelle Session jedoch bei 02:00:00:00 startet, 
wird die Spur bei 02:01:00:00 in die aktuelle 
Session eingefügt. 
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Map Start Timecode to hh:mm:ss:ff

Mit dieser Option platzieren Sie die Spuren relativ 
zur Startzeit der Original-Session. Wenn Ihre Session 
also beispielsweise bei 00:01:00:00 und die Export-
Session bei 10:00:00:00 beginnt, können Sie den 
Start-Timecode auf 00:01:00:00 stellen, um zu 
vermeiden, dass Dateien 9 Stunden und 59 Minuten 
nach Beginn der Session eingefügt werden.

Adjust Session Start Time to Match Source 
Start Time

Wenn diese Option aktiviert ist, wird die Startzeit 
der aktuellen Session an die Startzeit der 
importierten AAF- oder OMF-Sequenz 
angeglichen. Ist diese Option aktiviert, werden die 
Map Start Timecode to hh:mm:ss:ff-Option (und 
das Timecode-Eintragsfeld) deaktiviert.

Spur-Offset-Optionen
Beim Importieren von AAF- oder OMF-Spuren in 
Pro Tools können Sie zusätzlich zu den durch die 
Timecode Mapping-Optionen festgelegten 
Verschiebungen eine weitere zeitliche Verschiebung 
der Spuren angeben. Alle importierten Audiodaten 
werden in der Timeline der aktuellen Session um den 
angegebenen Wert verschoben. Werte können in 
Bars|Beats, Min:Sec, Timecode, Feet+Frames 
oder Samples eingegeben werden.

Samplerate-
Konvertierungsoptionen
Beim Importieren von AAF- oder OMF-Spuren in 
Pro Tool können Sie mithilfe dieser Einstellungen die 
Samplerate der Audiodateien der Session 
konvertieren. Sie können die Samplerate 
beispielsweise von 48 kHz in 44,1 kHz oder 
umgekehrt konvertieren. Avid HDX- und HD Native-
Systeme unterstützen Samplerates von mehr als 
48 kHz (88,2 kHz, 96 kHz, 176,4 kHz und 192 kHz). 
Mit diesen Einstellungen können Sie auch die 
Geschwindigkeitsänderung von 0,1 % (Pullup oder 
Pulldown) zwischen Filmmaterial mit 24 fps und 
NTSC-Videomaterial mit 29,97 fps ausgleichen. 
Außerdem können Sie die Geschwindigkeitsänderung 
von 4 % zwischen Filmmaterial mit 24 fps und PAL-
Videomaterial mit 25 fps ausgleichen.

Source Sample Rate

Mit dieser Einstellung können Sie unabhängig von 
den Samplerate-Einstellungen des Projekts die 
Samplerate des Audiomaterials festlegen, mit dem 
Sie in Pro Tools arbeiten.

Beispiel: Sie arbeiten an einem Projekt, das in 
Media Composer mit 44,1 kHz erstellt wurde. 
Wenn Sie in Pro Tools mit 48 kHz arbeiten 
möchten, sollten Sie die Source Sample Rate-
Einstellung auf 44.100 und die Destination Sample 
Rate-Einstellung auf 48.000 setzen.

Diese Einstellungen können auch für das Beheben 
von Pullup- und Pulldown-Problemen verwendet 
werden. Beispiel: Sie empfangen eine AAF- oder 
OMF-Übertragung von einem Film Composer-
System mit Audiomedien mit „Filmgeschwindigkeit“ 
bei der Wiedergabe mit 48 kHz. Sie können nun 
alle Audiodateien und Clips so konvertieren, dass sie 
mit NTSC-Videogeschwindigkeit und 48 kHz 
wiedergegeben werden. 

Wenn die Startzeit der importierten Sequenz 
hinter der der aktuellen Session liegt, wird 
die Maintain Absolute Timecode Values-
Option deaktiviert.

Es kann vorkommen, dass Clips, die sich in 
der Nähe der Zeitgrenze der aktuellen 
Session befinden, beim Aktivieren von 
„Adjust Session Start Time“ und der 
Auswahl von „Maintain Relative Timecode 
Values“ über die Grenzen der Session 
hinweg verschoben werden. In diesen Fällen 
wird eine Warnung angezeigt und Pro Tools 
kann die Session-Startzeit nicht angleichen.

Unter „Geschwindigkeitskorrektur für Film, 
NTSC-Video und PAL-Video“ auf Seite 1231 
finden Sie Informationen zum Konvertieren 
zwischen verschiedenen Geschwindigkeiten 
und Samplerates.
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Setzen Sie in diesem Fall die Source Sample Rate-
Einstellung auf 47.952 und die Destination Sample 
Rate-Einstellung auf 48.000. Mithilfe dieser 
Einstellungen zeigen Sie Pro Tools an, dass Sie 47.952 
Samples mit Original-„Filmgeschwindigkeit“ in 
48.000 Samples der neuen „Videogeschwindigkeit“ 
einpassen möchten. Mit diesen Einstellungen wird die 
Samplerate des Materials in die NTSC-
Videogeschwindigkeit konvertiert. 

Sie können die Source Sample Rate-Einstellung 
durch Auswählen einer vordefinierten Samplerate 
aus dem Popup-Menü oder durch Eingeben des 
gewünschten Werts in das Textfeld festlegen.

Destination Sample Rate

Mit dieser Einstellung legen Sie die Audio-
Samplerate der Ziel-Session (siehe Session Setup-
Fenster) sowie die Samplerate aller Audiodateien in 
der Ziel-Session fest. Hier sind u. a. die Standard-
Samplerates von Pro Tools (44,1 kHz und 48 kHz) 
verfügbar. Avid HDX- und HD Native-Systeme 
unterstützen Samplerates von mehr als 48 kHz 
(88,2 kHz, 96 kHz, 176,4 kHz und 192 kHz).

Wenn sich diese Einstellung von der Source Sample 
Rate-Einstellung unterscheidet, wird die Samplerate 
des Audiomaterials digital in die Ziel-Samplerate 
(Destination Sample Rate) konvertiert.

Conversion Quality-Popup-Menü

In diesem Popup-Menü können Sie die den 
Einstellungen für die Samplerate-Konvertierung 
Pro Tools entsprechenden Einstellungen 
vornehmen. Die Tweak Head (Slowest)-Option 
liefert die besten Ergebnisse.

AAF/OMF-Quellspur-
Umwandlungseinstellungen
Pro Tools stellt beim Import von AAF-Sequenzen 
oder OMF-Dateien bzw. -Sequenzen spezifische 
Optionen zum Umwandeln von Audioclips bereit.

Import Rendered Audio Effects

Durch Aktivieren der Import Rendered Audio 

Effects-Option werden Clips als Audioclips mit den 
auf den Clip angewendeten gerenderten Effekten 
(etwa EQ) importiert. Es ist sinnvoll, diese Option zu 
deaktivieren, wenn Sie Pro Tools-Audioeffekte und -
Audioverarbeitung ausschließlich für die 
Audiopostproduktion verwenden möchten. Durch 
die Deaktivierung dieser Einstellung erhalten Sie das 
unbearbeitete Quellmaterial als Audio.

Import Clip Gain

Mithilfe der Import Clip Gain -Einstellung können 
Sie clipbasierte Gain-Einstellungen importieren 
oder fortfahren, ohne clipbasierten Gain zu 
verwenden. Media Composer und andere Avid-
Produkte verwenden Clip-Gain zum Anpassen der 
Lautstärke einzelner Audioclips. 

Clipbasierter Gain unterscheidet sich von der 
standardmäßigen Lautstärkeanpassung einer 
ganzen Spur oder der Breakpoint-
Lautstärkeautomation in Pro Tools. Aktivieren Sie 
diese Option, um clipbasierte Gain-Daten aus der 
eingehenden Sequenz zu importieren.

Import Volume Automation

Die Import Volume Automation-Einstellung 
ermöglicht es Ihnen, die Breakpoint-
Lautstärkeautomation zu importieren oder die 
Lautstärkeautomation zu ignorieren. Der Media 
Composer und andere Avid-Produkte ermöglichen 
die Lautstärkeautomation und damit eine dauerhafte 
Lautstärkeanpassung für eine gesamte Sequenz.
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Pan Odd Tracks Left/Even Tracks Right

Mithilfe der Pan Odd Tracks Left/Even Tracks 

Right-Einstellung können Sie die 
Grundeinstellungen für Spurpanorama so 
einstellen, dass Spuren mit ungerader Zahl ganz 
links und Spuren mit gerader Zahl ganz rechts 
gepannt werden. Dies ist hilfreich, wenn Sie das 
nicht gepannte Audio ganz links oder ganz rechts 
pannen möchten.

Markers To Import

Sequenzen von Avid Media Composer können 
Metadatenpunkte (sogenannte „Marker“) enthalten, 
die einen ähnlichen Zweck erfüllen wie die Marker in 
Pro Tools, indem sie der Timeline farbig 
gekennzeichnete Kontextinformationen hinzufügen. 
Obwohl die Marker mit bestimmten Spuren in Media 
Composer verknüpft sind, können Sie sie in 
Pro Tools importieren, ohne dass auch die Spuren 
importiert werden müssen.

Beim Importieren von AAF-Sequenzen aus Media 
Composer werden Marker-Informationen mit 
eingeschlossen und können als Marker in 
Pro Tools importiert werden. Somit bleiben diese 
Daten erhalten.

So importieren Sie alle Marker: 

 Wählen Sie im Markers to Import-Menü die 
Option All.

So vermeiden Sie den Import von Markern:

 Wählen Sie im Markers to Import-Menü die 
Option None.

So importieren Sie farbbasierte Marker:

1 Klicken Sie auf das Markers to Import-Menü.

2 Wählen Sie die Farbe der zu importierenden 
Marker. Neben den ausgewählten Farben 
werden Häkchen angezeigt.

Nach dem Import können die neuen Marker wie 
gewöhnlich bearbeitet werden. 

Track Data to Import-Popup-Menü

Im Track Data to Import-Popup-Menü können Sie 
die Attribute ausgewählter Spuren bestimmen, die 
Sie in die aktuelle Session importieren möchten. 
Die ausgewählten Attribute werden für alle zu 
importierenden Spuren übernommen. Weitere 
Informationen zu Track Data To Import-Optionen 
finden Sie unter „Track Data to Import“ auf 
Seite 352.

Die Pan Odd Tracks Left/Even Tracks Right-
Einstellung wird beim Importieren von 
Mehrkanal-Audiospuren aus einer AAF-
Sequenz nicht unterstützt. Beim Importieren 
von Mehrkanalspuren wird die Einstellung in 
Grau angezeigt und die importierten 
Stereokanäle werden ganz links und ganz 
rechts gepannt.

Marker können nur aus AAF-Sequenzen 
importiert werden. 

Im Gegensatz zu Pro Tools-Markern, die nur 
bestimmte Zeitpunkte in einer Session 
kennzeichnen, verweisen Media Composer-
Marker insbesondere auf einzelne Audio- oder 
Videospuren. Informationen darüber, mit 
welcher Spur die einzelnen Marker verknüpft 
waren, erhalten Sie im Comments-Abschnitt des 
Memory Locations-Fensters in Pro Tools.

Wenn Media Composer-Marker in Pro Tools 
importiert werden, wird der dazugehörige 
Kommentartext dem Markernamen in Pro Tools 
hinzugefügt (max. 31 Zeichen). Kommentare, die 
mehr als 31 Zeichen umfassen, können im 
Memory Locations-Fenster in Pro Tools 
vollständig angezeigt werden.
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Legen Sie beim Importieren von AAF in Pro Tools 
mithilfe des Track Data to Import-Menüs fest, ob die 
Plug-Ins und die dazugehörigen Einstellungen 
ebenfalls importiert werden sollen.

So importieren Sie Plug-In-Einstellungen beim 
Import von AAF-Spuren oder -Sequenzen:

1 Öffnen Sie das Track Data to Import-Menü.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie All.

• Wählen Sie Some und vergewissern Sie sich, 
dass Plug-In Assignments aktiviert ist.

So vermeiden Sie, dass Plug-In-Einstellungen 
beim Import von AAF-Spuren oder -Sequenzen 
importiert werden:

1 Öffnen Sie das Track Data to Import-Menü.

2 Wählen Sie „Some“ und vergewissern Sie sich, 
dass Plug-In Assignments deaktiviert ist.

Main Playlist Options
Beim Importieren von AAF- oder OMF-Spuren in 
Pro Tools können Sie die Parameter für den Import 
der Haupt-Playlist aller Ausgangsspuren in die 
Zielspur der aktuellen Session festlegen. Siehe 
„Main Playlist Options“ auf Seite 355.

Exportoptionen von Media 
Composer für Audio- und 
Video-Mixdowns
Für AAF aus Avid-Anwendungen stehen Ihnen 
folgende Exportoptionen zur Verfügung:

• Zum Exportieren eines Video-Mixdowns 
einschließlich der dazugehörigen Editing-
Metadaten sollte der Avid-Editor im Export 
Method-Popup-Menü die Video Mixdown-Option 
und anschließend die Mixdown with Video Edits-
Option im Export Settings-Dialogfeld wählen.

• Zum Exportieren eines Audio-Mixdowns 
einschließlich der dazugehörigen zu 
bearbeitenden Metadaten sollte der Avid-Editor 
im Export Settings-Dialogfeld die Add Audio 
Mixdown Track(s)-Option wählen.

Kompatibilitätsprobleme 
bei Audiodateiformaten

AIFC
Avid Media Composer und weitere Editing-
Programme von Avid unterstützen Audiodateien im 
AIFC-Format, einer Version des Audio Interchange 
File Format (AIFF), die komprimierte Medien 
unterstützt. Pro Tools kann dieses Format 
importieren und verwenden, aber kein Audio in 
diesem Format komprimieren.

Sound Designer II

Unterstützung für AAF-Sequenzen, die auf 
SD II-Audiodateien verweisen

Mit Pro Tools können Sie AAF-Sequenzen 
importieren, die auf Sound Designer II(SD II)-
Audiodateien verweisen. Dennoch werden alle 
referenzierten Sound Designer II-Dateien 
automatisch in ein unterstütztes Audiodateiformat 
(WAV oder AIF) konvertiert.
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Translation Notes-Datei
Sollte es während des Imports einer AAF-Sequenz 
oder einer OMF-Datei bzw. -Sequenz zu Fehlern, 
abgeschnittenen Clipnamen oder anderen 
Warnhinweisen (etwa nicht gerenderten Effekten) 
kommen, wird ein Dialogfeld eingeblendet, über das 
Sie einen detaillierten Bericht der Änderungen 
aufrufen können. Klicken Sie auf Yes und wählen Sie 
den Pfad für die Datei mit den 
Umwandlungshinweisen (Translation Notes File) aus.

Die Translation Notes-Datei kann mit den meisten 
Textverarbeitungsanwendungen, die reine 
Textdateien darstellen können, geöffnet werden.

Format der Umwandlungshinweise

Die Umwandlungshinweise sind wie folgt 
strukturiert:

Spurname <Start des Timecodes–Ende des 
Timecodes> “Clipname (sofern 
verfügbar)”;Meldung

Umwandlungshinweise und Kategorien

Die Translation Notes-Datei ist in zwei Kategorien 
unterteilt. Im Folgenden werden 
Beispielmeldungen in den einzelnen Kategorien 
zusammen mit Erläuterungen und Lösungen 
(sofern erforderlich) angezeigt.

Analysefehler

Beispiel

A1<01:00:00:00–01:00:04:20>error 
readingcomponent “Assertion in 
OMF_Objects2x.cpp”, line 2871;substituting fill.

Diese Fehlermeldung zeigt ein Problem an, das 
möglicherweise in Pro Tools oder der Anwendung, 
mit der die AAF- oder OMF-Datei erstellt wurde, 
aufgetreten ist. In der umgewandelten Komposition 
ist an dieser Stelle eine Stille oder Schwarzvideo.

Fehlende Render-Ergebnisse

Beispiel 1

A1<01:00:02:00–01:00:07:01> no rendering for 
effect:EFF_AUDIO_EQMB;using bypass clip.

Diese Fehlermeldung gibt an, dass für einen 
vorhandenen Effekt kein Render-Ergebnis vorliegt 
und dass stattdessen ein anderer Clip verwendet wird. 
Bei diesem „Bypass-Clip“ handelt es sich um das 
unbearbeitete Ausgangsmaterial für den Effekt. 

Beispiel 2

V1<01:00:48:25–01:00:49:26>no rendering 
foreffect: omfi:effect: VideoRepeat; 
substitutingsilence/video black.

Bei einigen Effekten sind die Länge des 
Ausgangssignals und die des Eingangssignals 
nicht identisch. In diesem Fall ist bei Fehlen eines 
Render-Ergebnisses das Ersetzen durch einen 
„Bypass-Clip“ nicht sinnvoll, da das Material nicht 
synchron wäre. Pro Tools ersetzt dies durch Stille 
oder Schwarzvideo.

Ignorierte Effekte

A1<01:00:02:00–01:00:07:01>ignoring 
rendering for effect: EFF_AUDIO_EQMB;using 
bypass clip.

Diese Meldung zeigt an, dass der Anwender in 
Pro Tools die Ignore Rendered Audio Effects-Option 
ausgewählt hat. Dieser Hinweis dient lediglich zur 
Information. Sollte die umgewandelte Sequenz nicht 
den Erwartungen entsprechen, kann der Anwender 
feststellen, ob ein vorher ignorierter Effekt 
erforderlich ist.

Unvollständiges Render-Ergebnis

A1<00:00:28:29-00:00:31:17>incomplete 
rendering for effect Audio MultiBand EQ;using 
bypass clip.
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Diese Meldung gibt an, dass ein Effekt an einer 
Fade-Grenze in einem Avid-System nicht 
vollständig gerendert wurde. Beim Importieren hat 
Pro Tools das unvollständige Render-Ergebnis 
ausgelassen und das Audiomaterial ohne den 
Effekt importiert. Wenn Sie den Effekt verwenden 
möchten, rendern Sie den Effekt und den Fade 
erneut im Avid-System und führen Sie den Export 
erneut durch.

Beispiel

A1<01:00:00:00–01:00:16:06>“Jag film to 
Whirl.01.Sub.06.new.01”; insufficient source 
material for clip;shortening clip by 1 sample.

Dieser Umwandlungshinweis dient hauptsächlich der 
Information. Er gibt an, dass Pro Tools die AAF- oder 
OMF-Sequenz nicht genau umwandeln konnte und 
Anpassungen für Pro Tools vornehmen musste.

Dieser Fehler tritt auf, da verschiedene 
Anwendungen die Anzahl von Samples in einem 
Frame nicht immer auf die gleiche Weise 
berechnen. In einigen Fällen gibt es 
möglicherweise nicht ausreichend viele Samples 
von Medien, damit Pro Tools einen bestimmten 
Clip unterstützt. Hier kann es zu einem hörbaren 
Knackgeräusch kommen. 

Exportieren von Pro Tools-
Spuren als AAF- oder OMF-
Sequenzen
Pro Tools ermöglicht das Exportieren einzelner 
Spuren im AAF- oder OMF-Format. Verwenden 
Sie dazu den Export Selected Tracks as AAF/OMF-
Befehl.

Aus Pro Tools exportierte AAF- und OMF-
Sequenzen unterstützen keine Videodateien. Sie 
enthalten außerdem keine Informationen über 
Plug-In-Zuweisungen oder -Parameter, Routing 
oder Gruppierung. Es wird empfohlen, vor dem 
Exportieren alle Effekte zu rendern.

Pro Tools kann mit RF64-Audiodateien 
verknüpfte AAF- oder OMF-Sequenzen 
exportieren. Diese sind spezielle WAV-Dateien, 
die größer als 2 GB sein können (normale WAV-
Dateien haben eine Maximalgröße von 2 GB). 
WAV-Dateien, die größer sind als 2 GB, können 
nicht in Avid-Videobearbeitungsanwendungen 
geöffnet werden. Berücksichtigen Sie daher beim 
Export von AAF-/OMF-Sequenzen für Avid 
Video-Benutzer die Dateigröße.

Export to OMF/AAF-Dialogfeld
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So exportieren Sie ausgewählte Audiospuren als 
AAF- oder OMF-Sequenzen:

1 Wählen Sie in Pro Tools die zu exportierenden 
Spuren aus. Wählen Sie entweder gemischte 
oder nicht gemischte Dateien aus.

2 Wählen Sie File > Export > Selected Tracks as 

OMF/AAF.

3 Wählen Sie im Export As-Popup-Menü AAF 
oder OMF.

4 Wählen Sie bei Bedarf Enforce Avid Compatibility.

5 Stellen Sie sicher, dass Sie die korrekte 
Timecode-Formatoption des Zielprojekts 
(Target Project Timecode Format) für das 
Projekt in der Zielanwendung (wie etwa Avid 
Media Composer) auswählen.

6 Legen Sie gegebenenfalls die Sample Rate 

Conversion Options fest.

7 Richten Sie die Audio Media Options-
Einstellungen wie folgt ein:

• Stellen Sie sicher, dass Format und Bit Depth mit 
den Einstellungen in Ihrem Zielprojekt 
übereinstimmen (wie für das Projekt in Ihrer 
Video-Softwareanwendung eingestellt).

• Wählen Sie eine Copy-Option (Link to Source 

Media, Copy from Source Media oder 
Consolidate from Source Media).

8 Wenn Sie eine Sequenz mit Stereo-, 5.1- oder 
7.1-Mehrkanalspuren exportieren und diese 
Spuren beim Export ihre jeweilige 
Kanalanordnung beibehalten sollen, aktivieren 
Sie die Export Stereo, 5,1 and 7,1 Tracks as 

Multi-Channel-Option.

9 Wählen Sie weitere Export-Optionen aus.

10 Klicken Sie auf OK.

11 Geben Sie im Publishing Options-Dialogfeld die 
erforderlichen Informationen in die Felder 
„Pro Tools Comment“ und „Sequence Name“ ein.

12 Klicken Sie auf OK. 

13 Navigieren Sie im Save-Dialogfeld zu einem 
Ordner, indem Sie die AAF- oder OMF-Sequenz 
im Falle eines Übertragens an ein anderes Editing-
Programm oder eines Imports in Media Composer 
leicht wieder auffinden können.

14 Klicken Sie auf Save.

15 Navigieren Sie im Please Choose a Folder for 
Converted Audio Files-Dialogfeld zu einem 
Ordner, in dem Sie die Mediendateien leicht 
wieder auffinden können (etwa dem Ordner für 
die AAF- oder OMF-Sequenzen).

Halten Sie die Umschalttaste während der 
Auswahl gedrückt, um mehrere Spuren 
auszuwählen. Halten Sie die Wahl- (Mac) bzw. 
Alt-Taste (Windows) gedrückt, um alle 
auszuwählen.

Enforce Avid Compatibility begrenzt die 
Optionen für die Samplerate auf 44,1 und 
48 kHz und ermöglicht den Export von Glip-
Gain-Daten. Dithering ohne Rauschformung 
(Noise Shaping) wird auf Dateien angewendet, 
die von 24 Bit nach 16 Bit exportiert werden.

Weitere Informationen finden Sie unter 
„Exportoptionen für AAF- oder OMF-
Sequenzen“ auf Seite 373.

Publishing Options-Dialogfeld (Anzeige nach Auswahl 
der Export Selected Tracks as OMF/AAF-Option).

Für manche Video-Editing-Programme (wie etwa 
Avid Media Composer) müssen alle 
Mediendateien in bestimmten Ordnern abgelegt 
sein, damit sie erneut gekoppelt werden können.
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16 Klicken Sie auf Choose (Mac) oder Use 

Current Folder (Windows).

Pro Tools exportiert die Komposition und 
damit verbundene Mediendaten in die 
entsprechenden Ordner.

Exportieren von Mehrkanal-
Audiospuren
Stereo-, 5.1- und 7.1-Mehrkanalspuren können 
beim Export von AAF-Sequenzen als 
Mehrkanalspuren oder gesplittete Monospuren 
exportiert werden. Mehrkanalspuren werden beim 
Export von OMF-Sequenzen immer als mehrere 
Monodateien exportiert.

Exportieren des Clip-Gain
Wenn Sie bei aktivierter Enforce Avid Compatibility-
Option in AAF exportieren, erstellt Pro Tools auf der 
Grundlage der Clip-Gain-Daten jeder Spur Clip-
Gain-Daten im Media Composer-Format. 

Der Clip-Gain von Pro Tools-Clips mit einer 
statischen Lautstärke zwischen –INF dB und +12 dB 
wird beim Export direkt in clipbasierten Gain 
umgewandelt. Um die Kompatibilität mit Avid-
Videobearbeitungsanwendungen zu verbessern, wird 
der dynamische Glip-Gain und Clip-Gain mit Werten 
von über 12 dB für jeden Clip im zu exportierenden 
Medium gerendert.

Exportieren der Lautstärkeautomation in OMF

Pro Tools exportiert die Lautstärkeautomation in 
OMF, aber nur dann, wenn die Enforce Avid 
Compatibility-Option deaktiviert ist.

Exportieren von Fades
Während Pro Tools die Erstellung von Audiofades in 
Echtzeit unterstützt, werden alle Fades in der Sessions 
beim Export in AAF oder OMF auf Festplatte 
gerendert, um die Kompatibilität mit Avid-
Audiobearbeitungs-Anwendungen zu verbessern.

Clipgruppen
Pro Tools kann beim Export in AAF oder OMF keine 
Spuren mit Clipgruppen exportieren. Stellen Sie vor 
dem Export von Spuren aus einer Sequenz mit 
Clipgruppen in AAF oder OMF sicher, dass die 
Auswahl für alle Spuren mit Clipgruppen aufgehoben 
ist.

Exportieren von Pro Tools-
Spuren als MXF-Audiodateien
Sie können MXF-Audiodateien mithilfe folgender 
Befehle exportieren:

• Export Selected Tracks as OMF/AAF

• Bounce to Disk

• Export Selected Clips as Files

Exportieren von AAF-Sequenzen 
mit MXF-Audio
Verwenden Sie den Export Selected Tracks as 

OMF/AAF-Befehl zum Exportieren einzelner Spuren 
oder einer vollständigen Pro Tools-Session als AAF-
Sequenz , die auf MXF-Audiodateien verweist.

Videospuren können aus Pro Tools nicht in 
AAF oder OMF exportiert werden.

Die Enforce Avid Compatibility-Option muss 
aktiviert sein, um clipbasierte Gain-Daten 
exportieren zu können.

Clipbasierter Gain wird beim Export in 
das OMF-Format nicht exportiert.

Die Fades werden auch dann gerendert und 
exportiert, wenn Sie eine AAF-/OMF-
Sequenz mit aktivierter Link to Source Media-
Option erstellen.

Spuren werden vollständig exportiert, wobei 
die Zeitselektionen ignoriert werden.
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So exportieren Sie ausgewählte Audiospuren aus 
Pro Tools als AAF-Sequenz mit Verweis auf MXF-
Audiodateien:

1 Wählen Sie in Pro Tools die zu exportierenden 
Spuren aus.

2 Wählen Sie File > Export > Selected Tracks as 

OMF/AAF.

3 Wählen Sie unter OMF/AAF Options im Export 

As-Popup-Menü die Option AAF.

4 Wählen Sie Enforce Avid Compatibility.

5 Stellen Sie sicher, dass das Timecode-Format 
(Target Project Timecode Format) für das Projekt 
der Avid-Anwendung, in das Sie die AAF-Sequenz 
exportieren, korrekt eingestellt ist. 

6 Wählen Sie im Audio Media Options-Abschnitt 
aus dem Audio Format-Popup-Menü die MXF-
Option.

7 Überprüfen Sie, ob die Audio Bit Depth-
Einstellung für den Empfänger dieses Exports 
angemessen ist. 

8 Wenn Sie eine Sequenz mit Stereo-, 5.1- oder 
7.1-Mehrkanalspuren als Mehrkanal-
Audiodateien exportieren möchten, aktivieren 
Sie die Option Export Stereo, 5,1 and 7,1 

Tracks as Multi-Channel.

9 Klicken Sie auf OK. 

10 Geben Sie im Publishing Options-Dialogfeld die 
erforderlichen Informationen in die Felder 
„Pro Tools Comment“ und „Sequence Name“ ein. 

Pro Tools erstellt eine Sequenz mit dem von Ihnen 
angegebenen Namen. Der Kommentar wird in der 
Bin der Avid-Anwendung in der Pro Tools 
Comment-Spalte angezeigt.

11 Klicken Sie auf OK.

12 Navigieren Sie im Name the AAF to Export-
Dialogfeld zu einem Ordner, indem Sie die 
AAF-Sequenz im Falle eines Übertragens an 
ein anderes Editing-Programm oder eines 
Imports in Media Composer leicht wieder 
auffinden können.

13 Klicken Sie auf Save.

14 Navigieren Sie im Please Choose a Folder for 

Converted Audio Files-Dialogfeld zu einem 
Ordner, in dem Sie die Mediendateien leicht 
wieder auffinden können (etwa dem Ordner für 
die AAF- oder OMF-Sequenzen).

15 Klicken Sie auf Choose (Mac) oder Use 

Current Folder (Windows).

Pro Tools exportiert die AAF-Sequenz in den 
ausgewählten Ordner und die damit verbundenen 
Mediendaten in den Ordner „OMFI MediaFiles“ 
(OMF-Dateien) bzw. „Avid MediaFiles“ (MXF-
Dateien).

Lautstärke- und Panoramaautomation 
werden nicht exportiert, wenn „Quantize 
Edits to Frame Boundaries“ (Avid 
Compatibility Mode) aktiviert ist.

Eine OMF-Sequenz kann nicht auf MXF-
Mediendateien verweisen. Wenn Sie das Export 
Selected Tracks as OMF/AAF-Dialogfeld 
verwenden, wählen Sie „AAF“ im Export As-
Popup-Menü, um „MXF“ im Audio Format-
Menü zu aktivieren.

Dieser Befehl erstellt framegenaue Edits, 
verpackt die Dateien als OMFI (sofern Sie 
nicht „MXF“ wählen) und begrenzt die 
Samplerate-Optionen auf 44,1 oder 48 kHz. 
Dithering ohne Rauschformung (Noise 
Shaping) wird auf Dateien angewendet, die von 
24 Bit nach 16 Bit exportiert werden. Für manche Video-Editing-Programme (wie etwa 

Avid Media Composer) müssen alle 
Mediendateien in bestimmten Ordnern abgelegt 
sein, damit sie erneut gekoppelt werden können.
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16 Wenn Sie zum Importieren der Dateien in eine 
Avid-Anwendung bereit sind, beenden Sie 
Pro Tools.

Exportieren von MXF-
Audiodateien mit dem Bounce to 
Disk-Befehl
Mit dem Bounce to Disk-Befehl können Sie 
vorgemischte MXF-Audiodateien der aktuellen 
Pro Tools-Session erstellen. Dabei werden zwar 
nicht alle einzelnen Dateien in der Timeline 
exportiert, aber es wird sichergestellt, dass der 
Mix, den Sie in einer anderen Anwendung 
anhören, mit dem in Pro Tools gehörten Mix 
identisch ist. Dies schließt Panning, Effekte und 
Automation gänzlich mit ein.

So exportieren Sie mithilfe des Bounce to Disk-
Befehls nach MXF:

1 Nachdem Sie das Aufnehmen und Mischen 
einer Session in Pro Tools abgeschlossen 
haben, markieren Sie die gesamte Session-
Länge sowie etwas zusätzliche Zeit in der 
Timeline-Leiste (oder in einer Spur), um das 
Abschneiden möglichen Nachhalls am Ende 
eines Clips zu vermeiden.

2 Wählen Sie File > Bounce to > Disk.

3 Wählen Sie im Bounce-Dialogfeld Bounce Source. 

4 Wählen Sie Enforce Avid Compatibility.

Weitere Informationen zum Arbeiten mit 
Anwendungen von Avid finden Sie in den 
dazugehörigen Handbüchern.

Dieser Befehl erstellt framegenaue Edits, 
verpackt die Dateien als OMFI (sofern Sie 
nicht „MXF“ wählen) und begrenzt die 
Samplerate-Optionen auf 44,1 oder 48 kHz. 
Dithering ohne Rauschformung (Noise 
Shaping) wird auf Dateien angewendet, die von 
24 Bit nach 16 Bit exportiert werden.
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5 Wählen Sie MXF als Dateityp (File Type).

6 Wählen Sie eine Samplerate (Sample Rate) und 
eine Bitrate (Bit Depth). 

7 Klicken Sie auf Bounce.

8 Nehmen Sie im Publishing Options-Dialogfeld 
die folgenden Einstellungen vor: 

• Füllen Sie die Felder Comment und Clip Name 
aus.

• Wählen Sie ein Timecode-Format des Zielprojekts 
(Target Project Timecode Format), das mit dem 
des Projekts der Avid-Anwendung, in das Sie das 
MXF-Audio exportieren, übereinstimmt. 

Sämtliches in der Selektion befindliche hörbare 
Audiomaterial wird in zwei Multimono-Audio-
Dateien exportiert.

9 Wählen Sie im Save Bounce As-Dialogfeld das 
Laufwerk, auf dem die Dateien gespeichert 
werden sollen.

10 Klicken Sie auf Save.

Pro Tools beginnt mit dem Bouncing auf die 
Festplatte. In Pro Tools erfolgt das Bouncen in 
Echtzeit, sodass Sie während des Bounce-
Vorgangs die Audiowiedergabe Ihrer Mischung 
anhören (jedoch nicht beeinflussen) können.

Exportieren eines Clips als neue 
MXF-Datei
Mit dem Export Selected As Files-Befehl können 
Sie Clips als MXF-Audiodateien exportieren. 
Benutzen Sie diesen Befehl, wenn Sie einen Clip 
in anderen Sessions (oder anderen Audio-
Anwendungen) verwenden möchten, ohne die 
gesamte Quelldatei zu importieren. 

Dieser Befehl bietet auch eine Möglichkeit, 
Clips in eine andere Samplerate oder Bitrate 
zu konvertieren.

So exportieren Sie Clips als neue MXF-Dateien:

1 Wählen Sie in der Clipliste die zu 
exportierenden Clips aus.

2 Wählen Sie im Popup-Menü der Audioclip-
Liste den Export Selected As Files-Befehl.

3 Wählen Sie im Export Selected-Dialogfeld die 
Enforce Avid Compatibility-Option.

Bounce to Disk-Dialogfeld von Pro Tools (MFX-
Dateityp)

Publishing Options-Dialogfeld

Dieser Befehl erstellt framegenaue Edits, 
verpackt die Dateien als OMFI (sofern Sie 
nicht „MXF“ wählen) und begrenzt die 
Samplerate-Optionen auf 44,1 oder 48 kHz. 
Dithering ohne Rauschformung (Noise 
Shaping) wird auf Dateien angewendet, die von 
24 Bit nach 16 Bit exportiert werden.
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4 Wählen Sie im Audio Format-Popup-Menü die 
Option MXF.

5 Stellen Sie die Bitauflösung und die Samplerate 
ein. Legen Sie außerdem die 
Konvertierungsqualität (Conversion Quality) 
fest und wählen Sie das Zielverzeichnis 
(Destination Directory) aus.

6 Klicken Sie auf OK.

Exportoptionen für AAF- oder 
OMF-Sequenzen
Pro Tools bietet verschiedene 
Umwandlungseinstellungen für den Export von 
Spuren in OMF oder AAF, darunter „OMF/AAF 
Options“, „Sample Rate Conversion Options“ und 
„Audio Media Options“.

OMF/AAF Options
Pro Tools bietet folgende OMF/AAF-Optionen für 
den Export von Spuren in AAF oder OMF:

Enforce Avid Compatibility

Ist die Enforce Avid Compatibilty-Option aktiviert, 
erfüllen alle AAF-Sequenzen und OMF-Dateien und 
-Sequenzen die speziellen Anforderungen für Avid-
Video-Workstations. Die Samplerates sind auf 
44,1 kHz oder 48 kHz beschränkt. Exportierte Clips 
werden quantisiert und an die nächstliegende Frame-
Grenze angepasst (Quantize Edits to Frame 
Boundaries). Dieses Padding stellt sicher, dass die 
Positionierung einer Datei in der Timeline auf 
samplegenauen und auf framegenauen Systemen 
identisch ist. 

Target Project Timecode Format

Wählen Sie das Timecode-Format für das Projekt aus, 
in das die Datei oder Sequenz importiert werden soll. 
Dieses kann vom Timecode-Format der aktuellen 
Session abweichen. Mit diesem Parameter können 
Clips korrekt in Sessions mit verschiedenen 
Timecode-Formaten positioniert werden. Außerdem 
wird mit ihm die Anzahl der Samples berechnet, die 
hinzugefügt werden müssen, um Clips mit „Polstern“ 
an den Frame-Grenzen zu platzieren.

Quantize Edits to Frame Boundaries

Pro Tools ermöglicht ein samplegenaues 
Platzieren von Clips. In Pro Tools können Sie 
einen Clip beliebiger Länge an einer beliebigen 
Position platzieren, ohne dass die Clips an den 
Frame-Grenzen ausgerichtet werden müssen.

Jedoch unterstützen die meisten Video-Editing-
Programme, wie etwa Media Composer, nur eine 
framegenaue Bearbeitung. In diesen Programmen 
können Bearbeitungen des Tons nur an Grenzen 
zwischen ganzen Frames vorgenommen werden, was 
weniger präzise ist.

Bei Auswahl der Enforce Avid Compatibility-
Option wird automatisch die Quantize Edits to 

Frame Boundaries-Option aktiviert.

Wenn Sie eine Sequenz mit Mehrkanal-
Audiospuren exportieren, muss die Enforce 
Avid Compatibility-Option aktiviert sein.
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Mit der Quantize Edits to Frame Boundaries-
Option kann Pro Tools samplegenaue Pro Tools-
Edits in eine AAF- oder OMF-Datei exportieren, 
sodass sie framegenau erscheinen.

Wenn Sie die Quantize Edits to Frame Boundaries-
Option verwenden, müssen Sie unter „Audio 
Media Options“ eine Handle-Länge (Handle Size) 
angeben. Siehe „Consolidate Handle Size 
(Milliseconds)“ auf Seite 376.

Ein aus Clip plus Handle-Länge (am Anfang und 
am Ende des Clips) bestehender Master-Clip wird 
exportiert. Die exportierte Sequenz erstellt einen 
Subclip, der mit dem ursprünglichen Clip 

übereinstimmt, aber bis zu den äußersten Frame-
Grenzen gestreckt wird. Wenn der Clip etwa bei 
1:15 und 500 Samples beginnt, beginnt der Subclip 
bei 1:15; wenn er bei 4:00 und 500 Samples endet, 
endet der Subclip bei 4:01.

Da die Quantize Edits to Frame Boundaries-Option 
die Clips erweitert, kann u. U. unerwünschtes 
Audiomaterial hörbar werden. Damit dieses 
zusätzliche Audiomaterial nicht wiedergegeben wird, 
werden spezielle One-Frame-Sounddateien 
gerendert, um die ursprünglichen Clipgrenzen zu 
ersetzen. In der exportierten Sequenz werden diese 
One-Frame-Dateien (OFFs) über den Start- und den 
End-Frame des erweiterten Clips gelegt, sodass das 
angehängte Material nicht hörbar ist.

One-Frame-Dateien (OFFs) werden in Avid-
Workstations genau wie jede andere Sounddatei 
als Bestandteil einer AAF- oder OMF-Sequenz 
importiert. In der Avid-Timeline werden sie als 
One-Frame-Edits auf beiden Seiten eines Subclips 
angezeigt.

Wenn Sie irgendwann beschließen, den Subclip zu 
erweitern, verwerfen Sie die OFF und passen den 
Subclip nach Bedarf an.

Exportieren von Stereo-, 5.1- und 7.1-Spuren im 
Mehrkanalformat

Wählen Sie diese Option, wenn Sie möchten, dass 
Pro Tools Audiomaterial von Mehrkanalspuren 
generell als Mehrkanal-Audiodateien exportiert, 
und nicht als Bündel mehrerer Monodateien.

Die Quantize Edits to Frame Boundaries-
Einstellung muss ausgewählt sein, wenn Sie 
Ihre Pro Tools-Session für die Verwendung 
auf einer Workstation mit framegenauer 
Bearbeitung umwandeln. Deshalb wird diese 
Einstellung automatisch ausgewählt, wenn 
Sie Spuren mit aktivierter Enforce Avid 
Compatibility-Option exportieren.

Originalclip

Mit Handles exportierter Clip

Subclip: bis zu den äußersten Frame-Grenzen 
gestreckter Clip

Subclip mit durch OFFs (One Frame Files) 
überlagerten End-Frames

Diese Lösung steht nur zur Verfügung, 
wenn Sie eine Sequenz, und nicht einzelne 
Dateien, exportieren. 

Wenn die Quantize Edits to Frame 
Boundaries-Option ausgewählt ist, wird die 
Pro Tools-Lautstärkeautomation nicht 
exportiert.



Kapitel 17: Importieren und Exportieren von Session-Daten 375

Sample Rate Conversion-
Einstellungen
Mit diesen Einstellungen können Sie die Samplerate 
Ihrer Pro Tools-Session während des Exports in AAF 
oder OMF konvertieren, indem Sie die Samplerate für 
jede Audiodatei konvertieren und die Edits in der 
entstandenen AAF- oder OMF-Datei anpassen, um die 
vorgenommene Änderung auszugleichen.

Möglicherweise möchten Sie die Samplerate einer 
Session ändern, wenn Sie in ein anderes System 
exportieren oder wenn Sie bei einem Vorgang in 
einer bestimmten Situation eine andere Samplerate 
benötigen.

Beispiel: Ihre Session enthält Audiomedien mit 
29,97 fps (NTSC-Videogeschwindigkeit) und 
48 kHz, während für das Film Composer-System, in 
das Sie die Session exportieren, Audiomedien mit 
24 fps (Filmgeschwindigkeit) und 48 kHz 
erforderlich sind. Um alle Audiodateien und Clips so 
zu konvertieren, dass sie mit 24 fps 
(Filmgeschwindigkeit) und 48 kHz wiedergegeben 
werden, würden Sie in diesem Fall die Source 
Sample Rate-Einstellung auf 48.048 (Pull Up-Rate 
von 0,1 %) und die Destination Sample Rate-
Einstellung auf 48.000 setzen. Durch diese 
Einstellungen weiß Pro Tools, dass Sie die 48.048 
originalen Samples mit Videogeschwindigkeit in die 
48.000 Samples der neuen Filmgeschwindigkeit 
einpassen möchten. Mit diesen Einstellungen wird 
die Samplerate des Videomaterials in die 
Filmgeschwindigkeit konvertiert.

Source Audio Sample Rate

Mit dieser Einstellung können Sie unabhängig von 
den Samplerate-Einstellungen der Session die 
Samplerate des Materials festlegen, mit dem Sie in 
Pro Tools arbeiten.

Destination Audio Sample Rate

Mit dieser Einstellung können Sie die Samplerate 
für die Audiodateien nach der Umwandlung in 
AAF oder OMF festlegen. 

Wenn sich diese Einstellung von der Source Sample 

Rate-Einstellung unterscheidet, wird die Samplerate 
des Audiomaterials digital in die Ziel-Samplerate 
(Destination Sample Rate) konvertiert.

Sample Rate Conversion Quality

Diese Einstellungen entsprechen den 
Einstellungen für die Samplerate-Konvertierung in 
Pro Tools. Die Verwendung der Low (Fastest)-
Einstellung ist nicht empfehlenswert. Die Tweak 

Head (Slowest)-Einstellung bietet die höchste 
Qualität bei der Samplerate-Konvertierung.

Unter „Geschwindigkeitskorrektur für Film, 
NTSC-Video und PAL-Video“ auf Seite 1231 
finden Sie Informationen zum Konvertieren 
zwischen verschiedenen Geschwindigkeiten 
und Samplerates.

Überprüfen Sie die Pull-Optionen für Audio 
und Video, bevor Sie auf die ganze Session 
eine Samplerate-Konvertierung anwenden.
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Audiomedien-Optionen
Pro Tools bietet folgende Audio Media-Optionen 
für den Export von Spuren in AAF oder OMF:

Audio Format

Wählen Sie, ob die erzeugte AAF- oder OMF-
Datei auf BWF (.WAV), AIFF, SD II (nur Mac 
und OMF), MXF (nur AAF) oder auf eingebettete 
Dateien verweisen soll. Die Audiodateien werden 
entsprechend konvertiert.

Bit Depth

Wählen Sie für das exportierte Material als Ziel-
Bitrate 16 oder 24 Bit aus. Pro Tools wendet bei 
der Reduzierung der Bitrate von 24 auf 16 Bit 
automatisch einen Dither-Algorithmus ohne 
Rauschformung an.

Source Media

Beim Exportieren von Spuren aus Pro Tools in 
AAF oder OMF gibt es für die Behandlung der 
Audio-Quellmedien durch Pro Tools drei 
Möglichkeiten (siehe das Audio Media Options-
Popup-Menü im Export to OMF/AAF-
Dialogfeld).

Link to Source Media – mit dieser Option wird 
eine AAF- oder OMF-Datei erzeugt, die auf so 
viele ursprüngliche Mediendateien wie möglich 
verweist. In diesem Fall verweist die OMF-Datei 
auf die BWF- (WAV-), MXF-, AIFC- oder Sound 
Designer II-Dateien des Quellprojekts.

Copy From Source Media – mit dieser Option wird 
Audiomaterial auf ein anderes Laufwerk oder in 
einen anderen Ordner kopiert. Sie können die 
Samplerate-Konvertierung des Audiomaterials 
während dieser Übertragung vornehmen.

Consolidate From Source Media – mit dieser 
Option wird nur der tatsächlich von der Session 
verwendete Teil der Dateien kopiert. Es kann etwa 
vorkommen, dass Sie in Ihrer Session nur einen zehn 
Sekunden langen Clip einer zehn Minuten langen 
Audiodatei verwenden. Das Konsolidieren dieser 
Audiodatei spart erheblichen Speicherplatz, indem 
nur das tatsächlich verwendete Audiomaterial kopiert 
wird. 

Consolidate Handle Size (Milliseconds) – hier 
wird die Anzahl an Millisekunden der 
ursprünglichen Audiodatei angegeben, die am 
Anfang und Ende jedes erzeugten Audioclips 
beibehalten werden soll. Damit können Sie die 
Clipgrenzen sogar nach der Konsolidierung um 
einen von Ihnen festgelegten Wert erweitern. Ein 
Handle von mindestens 1000 Millisekunden (einer 
Sekunde) ist empfehlenswert, damit Sie 
übersteuertes oder zerstückeltes Material 
„heraustrimmen“ können. Consolidate Handle 

Size steht nur zur Verfügung, wenn Consolidate 

From Source Media ausgewählt ist.

Wenn Sie Audiodateien im AIFF- oder BWF-
Format (WAV) erzeugen, werden zusätzlich 
OMF-Daten an diese Audiodateien angehängt. 
Obwohl die meisten Anwendungen diese 
Audiodateien problemlos lesen können, sind sie 
eventuell nicht mit allen bestehenden 
Anwendungen kompatibel.

MXF ist nur verfügbar, wenn Sie die Enforce 
Avid Compatibility-Option ausgewählt haben.

„Consolidate from Source Media“ ist die 
einzige verwendbare Option für die 
Umwandlung von Pro Tools-Format in AAF 
oder OMF bei ausgewählter Quantize Edits to 
Frame Boundaries-Option. Siehe „Quantize 
Edits to Frame Boundaries“ auf Seite 373.
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Exportieren von Stereo-, 5.1- und 7.1-Spuren 
im Mehrkanalformat

Wählen Sie diese Option aus, wenn Sie eine Sequenz 
mit Mehrkanalspuren (Stereo, 5.1 oder 7.1) 
exportieren und möchten, dass diese Spuren beim 
Export ihre jeweilige Kanalanordnung beibehalten.

Publishing Options
Beim Exportieren von AAF- oder OMF-Dateien aus 
Pro Tools stehen über das Publishing Options-
Dialogfeld spezielle Optionen für die 
Veröffentlichung zur Verfügung, die Informationen 
über die Sequenz oder die Medien bereitstellen. 
Diese Optionen variieren je nach der zum Export der 
Dateien verwendeten Methode.

OMF-Optionen

Pro Tools Comment – gibt die Dateiquelle an und 
stellt sich standardmäßig auf den Namen der 
aktuellen Session ein. Das Pro Tools Comment-
Feld wird nicht angezeigt, wenn Sie den Export 

Selected as Tracks-Befehl verwenden, da das 
Audiomaterial auf einer Spur aus vielen 
verschiedenen Quellen stammen kann.

Sequence Name – dies ist der Name, der beim 
Import der Datei in ein anderes AAF- oder OMF-
kompatibles Programm angezeigt wird. Der 
Sequenzname entspricht nicht dem im Finder 
angezeigten Dateinamen. Standardmäßig erscheint 
in diesem Feld der Name des Pro Tools-Clips. 
Wenn Sie mehr als einen Clip exportieren, wird 
der Clipname automatisch für alle Clipnamen 
übernommen.

Target Project Timecode Format – dies ist das 
Timecode-Format für das Projekt, in das die Datei 
oder Sequenz importiert werden soll. Dieses kann 
vom Timecode-Format der aktuellen Session 
abweichen. Mit diesem Parameter können Clips 
korrekt in Sessions mit verschiedenen Timecode-

Formaten positioniert werden. Außerdem wird mit 
ihm die Anzahl der Samples berechnet, die 
hinzugefügt werden müssen, um Clips mit „Polstern“ 
an den Frame-Grenzen zu platzieren.

Zeitstempel

Wenn Sie in AAF oder OMF exportieren, werden 
alle exportierten Medien mit einem Zeitstempel 
versehen. Bei einem Zeitstempel handelt es sich 
um eine spezifische Timecode-Position, die in 
einer einzelnen Mediendatei gespeichert wird.

Der Zeitstempel kann Folgendes angeben:

• Timecode-Position auf dem Quellband

• Position, an der die Datei ursprünglich in der 
Pro Tools-Timeline aufgenommen wurde

• Position, an der ein Clip in einer Avid- oder 
Pro Tools-Timeline platziert war

• Vom Anwender festgelegte Timecodes

Zeitstempel können innerhalb einer Mediendatei 
an drei verschiedenen Orten gespeichert werden:

• in einer Clipdefinition

• in den Metadaten zum Dateiformat (etwa WAV-
Datei-Wrapper)

• im AAF- oder OMF-Wrapper

Exportieren eines Clips

Beim Exportieren eines Clips gibt der Zeitstempel 
den Startpunkt des Clips relativ zu der Position an, an 
der in der Datei ursprünglich mit der Aufnahme 
begonnen wurde. Wenn Sie beispielsweise eine Datei 
von 1:00 bis 1:30 aufnehmen und die Aufnahme 
dann auf einen Start bei 1:15 trimmen, wäre der 
Zeitstempel für den exportierten Clip 1:15. Dies trifft 
auch dann zu, wenn der Clip an eine andere Position 
in der Timeline verschoben wird.
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Exportieren eines Clips als Teil einer 
Sequenz

Wenn Sie einen Clip als Teil einer Sequenz 
exportieren, gibt der Originalzeitstempel des Clips 
dessen Position in der Timeline der Sequenz wieder.

Exportieren einer Datei

Recorded in Pro Tools – wenn die Datei in 
Pro Tools aufgenommen wurde, entspricht der 
Zeitstempel der Position in der Timeline, an der 
die Aufnahme gestartet wurde. Wenn Sie 
beispielsweise eine Datei von 1:00 bis 2:00 
aufnehmen, ist der Zeitstempel 1:00.

AudioSuite – wenn die Datei mit AudioSuite 
erstellt wurde, hängt der Zeitstempel von dem 
beim Rendern der Datei verwendeten Rendering-
Modus ab. Wenn Sie den Create Individual Files-
Modus auswählen, entspricht der Zeitstempel der 
neuen Datei dem Zeitstempel der Quelldatei. 
Wenn Sie Create Continuous File auswählen, 
entspricht der Zeitstempel der neuen Datei der 
Position der Quelldatei auf der Timeline.

Existing Time Stamp – wenn eine Datei mit einem 
bereits bestehenden Zeitstempel importiert wird, wird 
dieser Zeitstempel auch für die exportierte Datei 
angewendet. Wenn die ursprüngliche Datei einen 
Zeitstempel im Wrapper-Format enthält, wird er beim 
Export in den OMF-Wrapper kopiert.

Exportieren einer Datei ohne 
Zeitstempel

Wenn Sie eine Datei importieren, die keinen 
Zeitstempel enthält (wie etwa einen Soundeffekt von 
einer CD), ist der Zeitstempel beim Export gleich 0.

Importieren von Dateien aus einer AAF- 
oder -OMF-Sequenz von Avid

Wenn Sie eine Datei von einer AAF- oder OMF-
Sequenz von Avid importieren, wird der 
Quellband-Zeitstempel der Mediendatei zum 
Originalzeitstempel der neuen Pro Tools-Datei. Im 
Benutzerzeitstempel wird der Originalzeitstempel 
beibehalten.

Exportieren ausgewählter 
Spuren als neue Session
Pro Tools erlaubt Ihnen den Export beliebiger 
ausgewählter Spuren einer Session als neue 
Session. Dieser Befehl ersetzt den Export Session 
Data-Befehl älterer Pro Tools-Versionen. Diese 
Möglichkeit ist besonders dann hilfreich, wenn Sie 
mit anderen zusammenarbeiten. 

Beispiel: Sie arbeiten in der Postproduktion an einer 
umfangreichen Session und wollen, dass Ihr Kollege 
den Dialog bearbeitet, während Sie an anderen Teilen 
der Session weitermachen. Sie wählen also die 
Dialogspuren aus und exportieren sie als neue Session. 
Ihr Kollege öffnet die Session und bearbeitet den 
Dialog. Wenn er fertig ist, importieren Sie die Dateien 
aus seiner Dialog-Session und aktualisieren damit Ihre 
Master-Session.

So exportieren Sie ausgewählte Spuren als neue 
Session:

1 Wählen Sie die Spuren aus, die als neue Session 
exportiert werden sollen.

2 Wählen Sie File > Export > Selected Tracks As 
New Session. Das „Session-Kopie speichern“-
Dialogfeld wird geöffnet. (Sie können das Save 
Session Copy-Dialogfeld auch über File > Save 
Copy In aufrufen.)

Workspace bietet folgende Spalten für 
spezifische OMF-Metadaten von Avid: 
„Clip Name“, „Tape“, „FPS“, „Original 
Timestamp“ und „User Timestamp“.
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3 Vergewissern Sie sich, dass die Selected Tracks 

Only-Option im Save Session Copy-Dialogfeld 
aktiviert ist.

4 Konfigurieren Sie die Session-Format- und 
Session-Parameter-Einstellungen und -optionen.

5 Konfigurieren Sie die Einstellungen für Items to 

Copy.

6 Weiterhin können Sie die Main Playlist Only-
Option aktivieren, wenn Sie die alternativen 
Playlists für die ausgewählten Spuren nicht in 
die neue Session aufnehmen möchten.

7 Klicken Sie auf OK. Das Save-Dialogfeld 
wird geöffnet.

8 Geben Sie der Session im Save-Dialogfeld 
einen Namen.

9 Navigieren Sie an den Ort, an dem Sie die 
Session ablegen möchten.

10 Klicken Sie auf Save.

Eine Kopie der Quell-Session, die nur die 
ausgewählten Spuren enthält, wird am 
angegebenen Ort gespeichert.

Exportieren von Session-
Informationen als Text
Mit dem Export Session Info as Text-Befehl 
können Sie eine Textdatei mit ausführlichen 
Informationen zu Ihrer Session erstellen. 

Diese Textdatei kann eine Liste von Audiodateien, 
Audioclips, Audiospuren, EDL-Informationen zu 
Audiospuren (Edit Decision List), Zeitstempel und 
Überblendungen enthalten.

Spur-EDLs werden als tabulatorgetrennter Text 
exportiert, d. h., alle Spaltenüberschriften und alle 
Event-Parameter sind durch Tabulatorzeichen 
getrennt. Sie können diese Daten in einem 
Programm zum Lesen von EDLs verwenden oder 
die EDL-Daten zur Verwendung in einem 
Textverarbeitungs- oder 
Tabellenkalkulationsprogramm in Tabellenform 
formatieren.

So exportieren Sie Session-Informationen als Text:

1 Wählen Sie File > Export > Session Info as Text.

2 Legen Sie fest, ob die Datei-Liste, Clipliste und 
die Spur-EDLs mit exportiert werden sollen.

3 Wenn Spur-EDLs exportiert werden sollen, 
wählen Sie aus, ob Subframes angezeigt und 
Benutzerzeitstempel angegeben werden sollen. 
Wählen Sie auch eine Option, die festlegt, wie mit 
Crossfades verfahren werden soll.

Save Session Copy-Dialogfeld

Weitere Informationen zu den Save Session 
Copy-Dialogfeld-Einstellungen finden Sie 
unter „Save Copy In-Optionen“ auf Seite 166.
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4 Wenn Sie sich für den Export von Spur-EDLs 
entscheiden, wählen Sie für die zu exportierende 
Session-Textdatei ein Zeitformat (Time Format) 
im Popup-Menü aus.

5 Wählen Sie im Popup-Menü das Dateiformat 
für den exportierten Text aus.

6 Klicken Sie anschließend auf OK. 

7 Wählen Sie einen Speicherort für die 
exportierte Textdatei aus und geben Sie einen 
Dateinamen ein. Unter Windows fügt Pro Tools 
die richtige Dateinamenerweiterung hinzu 
(3 Buchstaben), während unter Mac die 
Dateinamenerweiterung „.txt“ angehängt wird.

Exportierte Session-Textdateien

Session-Informationen

Am Anfang der Textdatei finden Sie grundlegende 
Informationen zur Session. Dazu gehören der 
Name der Session, die Samplerate, die Bitrate, das 
Timecode-Format, die Anzahl der Audiospuren, 
Audioclips und Audiodateien, wie im folgenden 
Beispiel gezeigt wird.

Datei- und Clipliste

Anschließend folgt die Liste der Audiodateien und 
-clips, falls Sie diese exportieren möchten.

Spur-EDLs

Als letztes Element des Session-Texts wird eine Liste 
der Spur-EDLs angeführt, wenn diese exportiert 
werden. Eine Spur-EDL enthält den Spurnamen, alle 
Edits einschließlich der Nummer des Events, den 
Namen des Clips, die Start- und Endposition des Clips 
und die Wiedergabedauer des Clips. Wenn Sie die 
entsprechende Option auswählen, wird der 
Zeitstempel des Clips ebenfalls exportiert. In jedem 
Zeitfeld werden die Subframes angezeigt, wenn Sie 
die entsprechende Option aktiviert haben.

Optionen beim Exportieren 
von Sessions als Text

Include File List

Wählen Sie diese Option aus, um eine Liste der 
Audiodateien in der Session zu exportieren. Die 
Dateiliste werden alle Audiodateien in der Session 
und Informationen zu ihrem Speicherort auf der 
Festplatte aufgeführt.

Beispiel für Session-Informationen

SESSION NAME: Ripleys II-092700

SAMPLE RATE: 48000,000000

BIT DEPTH: 24 Bit

TIMECODE FORMAT: 30 Frame

# OF AUDIO TRACKS: 19

# OF AUDIO CLIPS: 203 

# OF AUDIO FILES: 54
Export Session Text-Dialogfeld
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Include Clip List

Wählen Sie diese Option aus, um eine Liste der 
Audioclips in der Session zu exportieren. Die 
Clipliste enthält alle Audioclips in der Session 
sowie die Quell-Audiodatei jedes einzelnen Clips.

Include Markers

Wählen Sie diese Option aus, um eine Liste aller in 
der Session enthaltenen Marker zu exportieren.

Include Plug-In List

Wählen Sie diese Option aus, um eine Liste aller in 
der Session verwendeten Plug-Ins zu exportieren.

Include Track EDLs (Playlists)

Sie können auch Spur-EDLs (Playlists) exportieren. 
Anhand von Spur-EDLs können Sie die Platzierung 
von Clips und Edits stichprobenweise überprüfen 
oder in anderen Anwendungen Nachbearbeitungen 
vornehmen. In extremen Fällen können Sie anhand 
der EDL die gesamte Session neu erstellen.

Folgende Optionen stehen beim Exportieren von 
Spur-EDLs zur Verfügung:

Show Subframes – mit dieser Option können Sie 
Zeitinformationen zu Subframes mit den Spur-
EDLs exportieren, falls diese in Ihrer Session 
verwendet werden.

Include User Timestamps – auch 
Benutzerzeitstempel können mit Spur-EDLs 
exportiert werden. Ein Benutzerzeitstempel 
markiert eine benutzerdefinierte Position eines 
Clips in der Session oder auch die ursprüngliche 
Position des Clips bei der Aufnahme.

Fade Handling

Sie können bei Spur-EDLs wählen, ob Crossfades 
angezeigt bzw. ausgeblendet werden sollen oder ob 
überblendete Clips als Kombination erscheinen. Bei 
kombinierten Clips werden deren Länge und Position 
zur Mitte des Crossfades hin (für den eingehenden 
Clip) und von der Mitte des Crossfades weg (für den 
nachfolgenden Clip) aufgeführt.

Time Format

Sie können das gewünschte Zeitformat auswählen, 
auf dem die exportierten EDL-Informationen 
basieren. So können Sie etwa für die 
Nachbearbeitung das SMPTE-Format wählen, für 
die Erzeugung von Audio mit Rasterausrichtung 
dagegen die Bars:Beats-Option. 

Dateiformat

Auf Mac können Sie in die Textformate TextEdit, 
UTF-8, MS Excel, MS Word, Write Now, Word 
Perfect und AppleWorks exportieren. Auf Windows 
können Sie entweder in TextEdit oder UTF-8 
exportieren.

Importieren und Exportieren 
von Clipgruppen-Dateien
Pro Tools kann das Dateiformat für Clipgruppen 
(.rgrp) exportieren und importieren. Sie haben 
folgende Möglichkeiten:

• Trennen (Separieren) von Clipgruppen-
Metadaten von Audiodateien, um überflüssige 
Dateikopiervorgänge beim Exportieren von 
Audioclip-Gruppen zu vermeiden, die aus 
mehreren Quelldateien zusammengesetzt sind

• Exportieren von MIDI-Daten als Teil 
einer Clipgruppe

• Erstellen mehrspuriger Loops

Für MIDI-Spuren werden keine 
EDLs exportiert.
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Clipgruppen-Dateien enthalten folgende Metadaten:

• Verweise auf alle Audiodateien in der Clipgruppe

• Namen und relative Position von Clips in Spuren

• Eingebettete Fades und Crossfades

• Namen und Format von Clipgruppen (mit einer 
oder mehreren Spuren)

• Alle in der Clipgruppe enthaltenen MIDI-Daten 
(etwa Noten, Controller und Sysex)

• Spurnamen

• Elastic Audio Warp-Marker und TCE-Faktor

• Clip-Zeitbasis (Samples oder Ticks)

• Sync-Punkte

• Loops

• Tempo-Map

Folgende Metadaten sind nicht in Clipgruppen-
Dateien enthalten:

• Audio

• Automation 

• Plug-Ins

• Spur-Routing

• Taktart-Map 

• Cliplisten-Informationen

Pro Tools bietet mehrere Möglichkeiten zum 
Importieren von Clipgruppen in eine geöffnete 
Session:

• „Importieren von Clipgruppen mit den 
Menübefehlen von Pro Tools“ auf Seite 382

• „Importieren von Clipgruppen per Drag & 
Drop“ auf Seite 383

Importieren von Clipgruppen mit 
den Menübefehlen von Pro Tools

So importieren Sie Clipgruppen mit den 
Menübefehlen von Pro Tools:

1 Wählen Sie File > Import > Clip Groups und 
anschließend die zu importierende Clipgruppe.

2 Wählen Sie im Clip Group Import Options-
Dialogfeld aus, wo die importierte Clipgruppe 
platziert werden soll.

New Track – erstellt eine neue Spur, in die die 
Clipgruppe importiert wird.

Clip List – importiert die Clipgruppe in die Clipliste, 
von wo aus sie in Spuren platziert werden kann. 

3 Wenn Sie eine neue Spur erstellen möchten, 
wählen Sie in der Spur einen Speicherort für die 
importierte Gruppe aus.

Session Start – platziert die Gruppe am Start der 
Session. 

Song Start – setzt den Beginn der Gruppe auf den 
Song Start-Punkt. 

Selection – setzt den Beginn der Gruppe auf den 
Edit-Cursor oder den Beginn einer Auswahl in der 
Timeline.

Clip Group Import Options-Dialogfeld
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Spot – zeigt das Spot-Dialogfeld an, über das Sie 
die Gruppe an präzisen Positionen, basierend auf 
einer der Zeitskalen, positionieren können.

4 Wählen Sie eine der folgenden Importoptionen:

Import Tempo Map from Clip Group File – wenn 
diese Option ausgewählt ist, wird die 
Tempozuweisung der Session durch die 
Tempozuweisung der Clipgruppe ersetzt. Diese 
Option ist nur verfügbar, wenn die Clipgruppe an 
den Anfang der Session importiert wird.

5 Klicken Sie auf OK. 

Importieren von Clipgruppen per 
Drag & Drop
Sie können Clipgruppen aus einem Workspace-
Browser oder dem Windows Explorer bzw. Mac 
Finder in die Timeline, eine Spur, die Tracks-Liste 
oder die Clipliste ziehen.

So importieren Sie Clipgruppen in die Clipliste:

1 Wählen Sie eine oder mehrere Clipgruppen in 
einem Workspace-Browser, im Windows 
Explorer oder Mac Finder. 

2 Ziehen Sie die Dateien in die Clipliste der 
aktuellen Session. 

So importieren Sie Clipgruppen in eine 
vorhandene Spur:

1 Wählen Sie eine oder mehrere Clipgruppen in 
einem Workspace-Browser bzw. über den 
Windows Explorer oder Mac Finder. 

2 Ziehen Sie die Dateien auf eine bestehende 
Spur im Edit-Fenster der aktuellen Session. 

So importieren Sie Clipgruppen in neue Spuren:

1 Wählen Sie eine oder mehrere Clipgruppen in 
einem Workspace-Browser, im Windows 
Explorer oder Mac Finder. 

2 Sie haben folgende Möglichkeiten:

• Halten Sie die Umschalttaste gedrückt, klicken 
Sie auf die Dateien im Workspace-Browser und 
ziehen Sie sie in das Edit-Fenster der aktuellen 
Session.

• Ziehen Sie die Dateien an eine leere Stelle im 
Edit-Fenster der aktuellen Session.

• Ziehen Sie die Dateien in die Tracks-Liste.

Exportieren von Clipgruppen

So exportieren Sie eine Clipgruppe:

1 Wählen Sie die gewünschten Clipgruppen in 
der Clipliste aus.

2 Wählen Sie in der Clipliste den Export Clip 

Groups-Befehl. 

3 Im Export Clip Group-Dialogfeld wird der Pfad 
des Zielverzeichnis standardmäßig auf den 
automatisch erstellten Clip Groups-Ordner im 
Session-Ordner festgelegt. Sie können den 
Destination Directory-Ordner ändern, indem Sie 
auf die Choose-Schaltfläche klicken, einen neuen 
Speicherort suchen und auf die Choose-
Schaltfläche klicken. Klicken Sie auf Reset, um 
die Standardeinstellung wiederherzustellen.

Export Clip Groups-Dialogfeld
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4 Aktivieren Sie eine der folgenden Optionen zum 
Korrigieren doppelter Clipgruppen-Dateinamen:

• Prompting for Each Duplicate 
(Standardeinstellung)

• Auto Renaming 

• Replacing with New Files 

5 Klicken Sie auf Export. 

Exportieren von Clipgruppen auf eine 
andere Festplatte

Im Allgemeinen sollten Sie beim Exportieren von 
Clipgruppen auf eine andere Festplatte die 
referenzierten Audiodateien kopieren. Auf diese 
Weise können Sie Clipgruppen nicht nur aus einer 
Session in eine andere, sondern auch von einem 
System auf ein anderes verschieben.

So exportieren Sie eine Clipgruppe und deren 
Audiodateien auf eine andere Festplatte:

1 Exportieren Sie eine oder mehrere Clipgruppen 
auf das neue Laufwerk.

2 Erstellen Sie eine neue Session auf dem neuen 
Laufwerk.

3 Wählen Sie Setup > Preferences.

4 Klicken Sie im Preferences-Dialogfeld auf die 
Processing-Registerkarte und wählen Sie 
Automatically Copy Files on Import.

5 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

6 Importieren Sie alle zuvor exportierten 
Clipgruppen, indem Sie sie in die Session 
ziehen und dort ablegen. 

Der Audio Files-Ordner der neuen Session enthält 
jetzt alle Dateien, die von den Clipgruppen 
referenziert werden.

Senden von Sessions an 
Gobbler
Gobbler ist ein Cloud-basiertes Tool für Backup, 
Übertragung und Zusammenarbeit zur Verwaltung 
von Audioprojekten und den zugehörigen 
Medienassets. Pro Tools arbeitet beim Senden von 
Pro Tools-Sessions und -Audiodateienan Kollegen 
über das Internet nahtlos mit Gobbler zusammen. 
Nach der Installation kann die Gobbler-Anwendung 
so konfiguriert werden, dass sie Ihr System 
automatisch nach Pro Tools-Sessions und 
zugehörigen Mediendateien durchsucht und diese 
sichert. Wenn Sie noch kein Konto haben, können 
Sie kostenlos eines erstellen.

Pro Tools ermöglicht das Senden Ihrer Pro Tools-
Sessions und zugehörigen Medien mithilfe des 
Send To Gobbler-Befehls. 

So senden Sie eine Session aus Pro Tools mit 
Gobbler:

1 Wählen Sie File > Send To > Gobbler.

2 Wenn Sie noch nicht bei Ihrem Gobbler-Konto 
angemeldet sind, werden Sie aufgefordert, sich 
anzumelden (siehe „Anmelden bei Gobbler“ 
auf Seite 1153).

3 Geben Sie im Send Files-Dialogfeld der 
Gobbler-Anwendung die E-Mail-Adresse ein, 
an die die Audiodatei gesendet werden soll.

4 Klicken Sie auf Send.

Weitere Informationen zu Gobbler finden Sie 
auf www.gobbler.com.

Weitere Informationen zum Freigeben einzelner 
Audiodateien aus Ihrer Pro Tools-Session mit 
Gobbler über die Bounce- und Export Selected-
Befehle finden Sie unter „Veröffentlichen auf 
Gobbler“ auf Seite 1152.
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Kapitel 18: Datei-/Sessionverwaltung und 
-kompatibilität

Beim Arbeiten mit Pro Tools werden Sie mit 
verschiedenen Dateitypen konfrontiert. Damit 
Pro Tools-Systeme ordnungsgemäß funktionieren 
können, müssen bestimmte Dateien in bestimmten 
Festplattenverzeichnissen abgelegt werden.

• Die Pro Tools-Software-Dateien (etwa die 
Anwendungs- und Plug-In-Dateien) sollten im 
Startlaufwerk (dem Laufwerk, das das 
Betriebssystem und andere systembezogene 
Dateien enthält) gespeichert werden.

• Datendateien (etwa Session-Dateien, Audio- 
und Videodateien) können auf einem beliebigen 
kompatiblen Laufwerk gespeichert werden, das 
an internen oder externen SAS-, SATA-, 
IDE/ATA-, FireWire- oder Thunderbolt-Bussen 
angeschlossen ist.

Beim Erstellen neuer Sessions können Sie den 
Speicherort der neuen Session-Dateien bestimmen 
(siehe „Erstellen einer neuen Session“ auf 
Seite 156).

Verwenden Sie in Pro Tools-Sessions den Disk 
Allocation-Befehl, um festzulegen, wo Sie die neu 
aufgenommenen Audiodateien speichern möchten 
(siehe „Arbeiten mit Festplatten für die 
Aufnahme“ auf Seite 445).

Pro Tools lässt zwar die Aufnahme auf das 
Systemlaufwerk zu, von dieser Einstellung 
wird jedoch im Allgemeinen abgeraten. 
Daher sollten Sie nur im Notfall auf 
Systemlaufwerke aufnehmen, etwa wenn Sie 
über nur eine Festplatte verfügen oder kein 
freier Speicherplatz auf den anderen 
Festplatten vorhanden ist.

Wenn Sie über ein System mit mehreren 
Laufwerken verfügen, können Sie festlegen, 
dass das Systemlaufwerk ausschließlich für 
die Wiedergabe oder den Transfer genutzt 
wird, um eine optimale Leistung zu erzielen 
(siehe „Volume-Berechtigungen“ auf 
Seite 286).
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Audiodateiverwaltung

Eindeutige Datei-IDs
Pro Tools versieht jede Audiodatei in einer Session 
mit einer eindeutigen Kennung, wodurch eine 
bestimmte Datei auch dann wiedererkannt wird, 
wenn ihr Name oder Speicherort geändert wurde.

Suchen von Audiodateien
In Pro Tools dient das Relink-Fenster zur 
Verwaltung von Links auf Audio- und 
andere Mediendateien. 

Pro Tools klassifiziert Speicher-Volumes anhand ihrer 
Eignung für die Performance (Aufnahme bzw. 
Wiedergabe) oder den Transfer (Speichern bzw. 
Kopieren) von Audio- und anderen Mediendateien. 
Damit Audiodateien in einer Pro Tools-Session 
wiedergegeben werden können, müssen sie nicht nur 
korrekt gekoppelt, sondern auch auf geeigneten 
Performance-Volumes gespeichert sein.

Beim Öffnen einer Session sucht Pro Tools nach 
nicht auf Performance-Volumes vorhandenen 
Audiodateien. Wenn die Audiodateien der Session 
nicht gefunden werden können, können Sie diese 
selbst suchen und die Session anschließend 
wiedergeben. Dieser Vorgang wird als Relinking 
(Neukopplung) bezeichnet. 

Transfer-Dateien

Transfer-Dateien werden auf Volumes gespeichert, 
die nicht für die Wiedergabe geeignet sind (etwa CDs 
bzw. DVDs und Netzwerklaufwerke).

So öffnen Sie eine Session mit Transfer-Dateien:

 Öffnen Sie die Pro Tools-Session. Wenn sich 
Dateien auf einem für die Wiedergabe 
ungeeigneten Volume befinden, fordert 
Pro Tools Sie zu Folgendem auf:

• Klicken Sie auf Yes, um das Copy and Relink-
Fenster zu öffnen.

• Klicken Sie auf No, um die Session zu öffnen 
und die Transfer-Dateien im Offline-Status 
zu belassen. 

So können Sie Transfer-Dateien in der aktuellen 
Session wiedergeben:

1 Wählen Sie die Session im Locations-Bereich.

2 Doppelklicken Sie auf den Audio Files-Ordner, 
um alle Audiodateien anzuzeigen.

3 Wählen Sie im Browser-Menü Select Transfer 

Files. 

4 Wählen Sie im Browser-Menü Copy and 

Relink. 

5 Geben Sie für die kopierten Dateien einen 
Speicherort auf einem gültigen Performance-
Volume an.

6 Klicken Sie auf OK. 
Weitere Informationen zur Klassifizierung 
von Speicher-Volumes finden Sie unter 
„Performance- und Transfer-Volumes“ auf 
Seite 283.

Weitere Informationen finden Sie unter 
„Koppeln und Neukoppeln von Dateien“ auf 
Seite 310.
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Fehlende Dateien

Dateien werden als fehlend gemeldet, wenn sie 
sich nicht mehr an dem Ort befinden, an dem sie 
zuletzt gespeichert wurden. 

So öffnen Sie eine Session mit fehlenden Dateien:

1 Öffnen Sie die Pro Tools-Session. 
Bei fehlenden Dateien wird eine entsprechende 
Warnmeldung angezeigt.

2 Wählen Sie eine der folgenden Optionen:

Skip All – überspringt alle fehlenden Dateien. 
Fehlende Dateien werden in der Session als offline 
angezeigt.

Manually Find and Relink – öffnet das Relink-
Fenster. Hier können Sie die fehlenden Dateien suchen, 
vergleichen, überprüfen und erneut koppeln.

Automatically Find and Relink – durchsucht alle 
Performance-Volumes nach den fehlenden Dateien 
(nach Namen, eindeutiger Datei-ID, Format und 
Länge) und koppelt sie, wenn dies möglich ist. 

3 Um gerenderte Elastic Audio-Dateien vom 
Neukoppeln auszuschließen und sie stattdessen 
neu zu generieren, wählen Sie Regenerate 

Missing Rendered Files Without Searching.

4 Klicken Sie auf OK. 

Renamed Audio Files
Umbenannte Audiodateien befinden sich im 
automatisch erstellten Renamed Audio Files-Ordner 
innerhalb des Session-Ordners von Pro Tools. 
Dateien werden evtl. umbenannt, wenn Sie eine 
Session öffnen, die Audiodateinamen mit 
inkompatiblen Zeichen referenziert. Außerdem kann 
dies auftreten, wenn Sie eine Kopie einer Session in 
einer Pro Tools-Version speichern, die lange 
Dateinamen nicht unterstützt.

Öffnen einer Session, die Audiodateinamen mit 
ungültigen Zeichen enthält

Pro Tools 7.x und höher unterstützt 
Audiodateinamen, die folgende ASCII-Zeichen 
enthalten, nicht:

/ (Schrägstrich)

\ (umgekehrter Schrägstrich)

: (Doppelpunkt)

* (Sternchen)

? (Fragezeichen)

“ (Anführungszeichen)

< (Kleiner-als-Zeichen)

> (Größer-als-Zeichen)

| (senkrechter Strich, Verkettungszeichen)

Komplexe (durch Tastenkombination erstellte) 
ASCII-Zeichen

Beim Öffnen von Sessions, die Audiodateien mit 
unzulässigen Zeichen enthalten, erstellt Pro Tools 
automatisch Kopien der betreffenden Dateien 
unter neuen Namen. Die unzulässigen Zeichen 
werden dabei durch Unterstriche („_“) ersetzt. Die 
umbenannten Dateien werden in den Renamed 
Audio Files-Ordner kopiert. Die ursprünglichen 
Dateien bleiben im Audio Files-Ordner erhalten.

Warnmeldung zu fehlenden Dateien beim Öffnen 
einer Session

Weitere Informationen finden Sie unter 
„Koppeln und Neukoppeln von Dateien“ auf 
Seite 310.
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Bevor die Session geöffnet wird, werden Sie 
aufgefordert, einen ausführlichen Bericht über die 
umbenannten Dateien und die ursprünglichen 
Dateinamen in einer Notes-Textdatei zu speichern. 
Standardmäßig wird die Notes-Textdatei im 
Session-Ordner gespeichert.

Speichern einer Kopie einer Session, die lange 
Audiodateinamen enthält

Wenn Sie (mit „Save Copy In“) Dateien in Pro Tools 
6.9.x und niedriger speichern, werden Audiodateien 
mit Dateinamen, die die Beschränkungen des 
Zielformats übersteigen, abgeschnitten und 
folgendermaßen im Session-Ordner abgelegt:

• Wird die neue Session im selben Ordner wie das 
Original gespeichert, wird der Renamed Audio 
Files-Ordner im Originalordner der Session 
erstellt und die umbenannten Audiodateien 
werden darin abgelegt.

• Wird die neue Session in einem anderen Ordner als 
das Original gespeichert und die All Audio Files-
Option ist nicht ausgewählt, wird ein neuer 
Session-Ordner erstellt, der einen Audio Files-
Ordner und einen Renamed Audio Files-Ordner 
enthält. Die umbenannten Audiodateien werden 
im Audio Files-Ordner abgelegt.

• Wird die neue Session in einem anderen Ordner als 
das Original gespeichert und die All Audio Files-
Option ist ausgewählt, wird ein neuer Session-
Ordner erstellt, der einen Audio Files-Ordner 
enthält. Die umbenannten Audiodateien werden 
im Audio Files-Ordner abgelegt.

Kompatibilität von 
WAV-Dateien
Konvertieren importierter WAV-Dateien in 
AES31/BroadcastWave

In Pro Tools werden Dateien immer im 
AES31/Broadcast-kompatiblen Format BWF 
(.wav) erstellt. Andere WAV-Dateien als BWF 
können ohne Konvertierung zu Pro Tools-
Sessions im BWF-Format (WAV) hinzugefügt 
werden. Mit dieser Option wird sichergestellt, dass 
alle WAV-Dateien importiert und bei Bedarf in 
das mit dem AES31/EBU Broadcast-Standard 
kompatible BWF (WAV) konvertiert werden.

Das AES31/Broadcast Wave-Format ist eine 
Variante des Standard-WAV-Audiodateiformats. 
Das Format AES31 enthält zusätzlich zu den 
reinen PCM-Audiodaten SMPTE-Zeitstempel und 
weitere Informationen. 

Diese Variante entspricht sowohl dem AES-
Standard (Audio Engineering Society) als auch 
dem EBU-Standard (European Broadcasters 
Union). Wählen Sie diese Option, um die 
Kompatibilität mit anderen Workstations zu 
gewährleisten, die diesen Dateityp unterstützen. 

So stellen Sie sicher, dass importierte WAV-
Dateien dem AES31/EBU Broadcast-Standard 
entsprechen:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Wählen Sie die Convert Imported “.wav” Files to 

AES31/BroadcastWave-Option.

3 Klicken Sie auf OK.

Sessions mit Pro Tools 7.x oder höher, 
die Audiodateinamen mit ungültigen Zeichen 
enthalten, sind trotzdem möglich. Wenn Sie 
die Session mit dem Save Copy In-Befehl 
unter Pro Tools 6.9.x oder niedriger mit 
aktivierter Mac/PC Compatibility speichern, 
werden die Spuren mit gültigen Zeichen 
umbenannt. Bei deaktivierter Mac/PC 
Compatibility werden die Zeichen 
nicht geändert.
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WAVE Extensible-Dateiformat 

Pro Tools 10 unterstützt bei Audiodateien das 
WAVE Extensible-Dateiformat. In diesem 
Dateiformat sind Daten für Mehrkanalaudio 
(Surround-Sound) zusammen mit den 
Lautsprecherpositionen im Datei-Header der 
Audiodatei gespeichert. Diese Audiodateien werden 
in Workspace-Browsern mit der Bezeichnung 
„WAV (BWF EXT)“ im Attributfeld 
gekennzeichnet. 

Wenn Sie mit Mehrkanalformaten (höher als Stereo) 
in Pro Tools-Sessions arbeiten, empfehlen wir, dass 
Sie das WAV-Format benutzen.

RF64

Pro Tools 10 unterstützt RF64-Audiodateien. RF64 
ist eine Erweiterung des WAV-Audiodateiformats, 
das die 4-GB-Größenbeschränkung der anderen 
WAV-Formate umgeht. RF64-Audiodateien werden 
in Workspace-Browsern mit der Bezeichnung 
„MBWF“ im Attributfeld gekennzeichnet.

Austauschen von auf 
verschiedenen Plattformen 
erstellten Sessions

Arbeiten mit Mac-basierten 
HFS+-Laufwerken auf 
Windows-Computern
Zur Nutzung von HFS+-Laufwerken auf einem 
NTFS-System und deren Verwendung mit Pro Tools 
können Sie das MacDrive-Dienstprogramm 
von Mediafour verwenden. 

Verschieben von Sessions von 
einem Windows-System auf 
Mac-basierte HFS+-Laufwerke
(Nur von Windows-basierten NTFS-
Laufwerken)

Zum Übertragen von Session-Dateien von einem 
Windows-basierten NTFS-Laufwerk auf ein Mac-
basiertes HFS+-Laufwerk ist eine bestimmte 
Vorgehensweise erforderlich.

So übertragen Sie Pro Tools Windows-Sessions 
von NTFS-Laufwerken auf HFS+-Laufwerke:

1 Setzen Sie die MacDrive-Optionen auf 
Backup/File Transfer.

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie den Session-Ordner aus dem NTFS-
Laufwerk auf das HFS+-Laufwerk.

• Öffnen Sie die Windows-Session auf dem 
NTFS-Laufwerk, wählen Sie Save Copy In und 
speichern Sie eine Kopie der Session auf dem 
HFS+-Laufwerk.

Bei WAV-Dateien in Pro Tools 10-Sessions 
wird die Kanalanordnung für jeden Kanal von 
Interleaved-Mehrkanaldateien in der Clipliste 
angezeigt.

Niedrigere Pro Tools-Versionen können keine 
RF64-Dateien lesen. Um diese Dateien in 
Systemen mit niedrigeren Pro Tools-Version 
verwenden zu können, müssen Sie sie manuell 
bearbeiten und konsolidieren, damit sie die 
Größe von 4 GB nicht überschreiten.
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Verschieben von Mac-basierten 
Sessions auf HFS+-Laufwerken 
auf Windows-Systeme
(Nur auf Windows-basierte NTFS-Laufwerke)

Zum Übertragen von Session-Dateien von einem 
Mac-basierten HFS+-Laufwerk auf ein Windows-
basiertes NTFS-Laufwerk ist eine bestimmte 
Vorgehensweise erforderlich.

So übertragen Sie Pro Tools Mac-Sessions von 
HFS+-Laufwerken auf NTFS-Laufwerke:

1 Setzen Sie die MacDrive-Optionen 
auf Normal Use.

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie den Session-Ordner aus dem HFS+-
Laufwerk auf das NTFS-Laufwerk.

• Öffnen Sie die Mac-Session auf dem 
HFS+ Laufwerk, wählen Sie Save Copy In 
und speichern Sie eine Kopie der Session 
auf dem NTFS-Laufwerk. 

Wenn in der Session zuvor SD II-Dateien 
verwendet wurden, werden diese in das neue 
Audiodateiformat konvertiert.

Aufnehmen und Wiedergeben 
von HFS+-Laufwerken unter 
Windows
Windows unterstützt die Aufnahme und 
Wiedergabe von Sessions direkt von Mac-
formierten Laufwerken (HFS+) anhand der 
MacDrive-Softwareanwendung.

Bei Verwendung von MacDrive für die Aufnahme 
und Wiedergabe auf einem Windows-System 
müssen die Session-Datei und sämtliche 
Audiodateien auf Mac-formatierten (HFS+-) 
Laufwerken gespeichert sein. Die Aufnahme und 
Wiedergabe einer Session von einer gemischten 
Umgebung aus Windows- und Mac-formatierten 
Laufwerken wird nicht unterstützt.

So erfolgt die Aufnahme oder Wiedergabe von 
HFS+-Laufwerken unter Windows anhand von 
MacDrive:

1 Öffnen Sie in Windows das Kontrollfeld von 
MacDrive.

2 Wählen Sie Options > File Names und 
anschließend die International Use-Option.

3 Löschen Sie sämtliche Optionen unter 
„File Name Maps“.

4 Wählen Sie in Pro Tools Window > Workspace 
und setzen Sie alle Mac-formatierten Volumes 
in den Spalten A (Audio) und V (Video) auf R 
(für Record = Aufnahme) oder P (für 
Playback = Wiedergabe). 

Anweisungen zum Speichern (oder Erstellen) 
von Mac-Sessions, die mit Windows-Systemen 
kompatibel sind, finden Sie unter „Speichern 
von mit Windows kompatiblen Kopien von 
Mac-Sessions“ auf Seite 391.

Beim Übertragen von Pro Tools-Sessions 
von HFS+- auf NTFS-Laufwerke können 
Pro Tools-Sessions mit Audiodateien, 
die unter Windows ungültige Mac-Zeichen 
enthalten, nicht neu gekoppelt werden. Diese 
Zeichen werden automatisch in Unterstriche 
(„_“) umgewandelt. Die Dateien werden im 
Renamed Audio Files-Ordner gespeichert. 
Sie müssen die Dateien manuell über Datei-
ID neu koppeln. Siehe „Fehlende Dateien“ 
auf Seite 387.

In früheren Versionen von Pro Tools 
konnten Mac-formatierte HFS+-Laufwerke 
bei Verbindung mit Windows-Systemen 
mithilfe von MacDrive nur als Transfer-
Volumes verwendet werden.
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Speichern von mit Windows 
kompatiblen Kopien von 
Mac-Sessions
(„Save Copy In“ nur unter Pro Tools 6.9.x und 
niedriger)

Unter Pro Tools 7.x oder höher erstellte und 
gespeicherte Sessions sind immer sowohl auf 
Windows- als auch auf Mac-Computern kompatibel.

Wenn Sie eine Session in Pro Tools 6.9.x oder 
niedriger auf einem Mac erstellen, ist sie nur mit 
Windows kompatibel, wenn bei der Verwendung 
des Save Copy In-Befehls die Enforce Mac/PC 

Compatibility-Option aktiviert ist. Außerdem sind 
beim Abschließen des Save Copy In-Befehls 
plattformübergreifende Beschränkungen zu 
beachten.

Einschränkungen für 
plattformübergreifende Sessions

Beim Speichern (oder Erstellen) einer Kopie einer 
Pro Tools-Session, die mit Mac und Windows 
kompatibel sein soll, müssen Sie folgende 
Beschränkungen und deren Auswirkung unter 
Pro Tools beachten:

Audiodateitypen

Das empfohlene Dateiformat für 
Plattforminteroperabilität ist BWF (.WAV). 
Um einen optimalen Austausch von Sessions zu 
ermöglichen, verwendet Pro Tools BWF als 
Standardformat für neue Sessions.

In Pro Tools können Sie eine Reihe von 
Audiodateiformaten speichern, bouncen und 
exportieren, darunter WAV, AIFF, MP3 und 
QuickTime. 

Dateinamenerweiterungen

Um eine plattformübergreifende Kompatibilität zu 
gewährleisten, müssen alle Dateien einer Session 
eine Dateinamenerweiterung mit 3 Buchstaben 
haben. Session-Dateien aus Pro Tools 5.1 bis 6.9.x 
tragen die Erweiterung „.pts“ und Pro Tools 5-
Sessions die Erweiterung „.pt5“. Die Erweiterung 
von Wave-Dateien ist „.wav“, die von AIFF-
Dateien „.aif“.

Inkompatible ASCII-Zeichen

Sie können in Namen für Clips, Spuren, Dateien 
und in Plug-In-Einstellungen keine ASCII-
Zeichen verwenden, die von einem der beiden 
Systeme nicht unterstützt werden. 

Wenn Dateien in eine Session importiert werden, 
werden inkompatible Zeichen in Unterstriche 
(„_“) konvertiert und die umbenannten Dateien im 
Renamed Files-Ordner abgelegt.

Die folgenden Zeichen können in Windows-
Sessions nicht verwendet werden:

/ (Schrägstrich)

\ (umgekehrter Schrägstrich)

: (Doppelpunkt)

* (Sternchen)

? (Fragezeichen)

“ (Anführungszeichen)

< (Kleiner-als-Zeichen)

> (Größer-als-Zeichen)

| (senkrechter Strich, Verkettungszeichen)

Komplexe (durch Tastenkombination erstellte) 
ASCII-Zeichen
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Speichern von plattformübergreifenden 
Sessions

So speichern Sie eine vorhandene Session in 
Pro Tools 6.9.x oder niedriger und behalten die 
Kompatibilität mit Mac und Windows bei:

1 Wählen Sie File > Save Copy In.

2 Wählen Sie im Save Session Copy-Dialogfeld 
ein Zielverzeichnis für die neue Session-Datei 
aus und geben Sie einen Namen für sie ein.

3 Legen Sie als Audiodateityp (Audio File Type) 
entweder „AIFF“ oder „BWF (WAV)“ fest. 
Diese Dateiformate sind mit beiden 
Betriebssystemen kompatibel.

4 Stellen Sie die Samplerate (Sample Rate) und 
die Bitrate (Bit Depth) für die Session ein.

5 Wählen Sie Enforce Mac/PC Compatibility. 
Diese Option muss aktiv sein, um eine 
plattformübergreifende Kompatibilität der 
Session zu gewährleisten.

6 Wählen Sie unter Items to Copy die Optionen 
für die neue Session aus.

7 Klicken Sie auf Save. 

Wenn in der Session zuvor SD II-Dateien 
verwendet wurden, werden diese in das neue 
Audiodateiformat konvertiert.

In Pro Tools ist es möglich, Dateien, die auf 
einem Mac erstellt und gespeichert wurden, 
ohne dass dabei die Enforce Mac/PC 
compatibility-Option aktiviert war, 
in Windows-kompatible Dateien 
zu konvertieren. Weitere Informationen 
finden Sie unter „Austauschen von auf 
verschiedenen Plattformen erstellten 
Sessions“ auf Seite 389.
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Austauschen von auf verschiedenen Plattformen 
erstellten Sessions
Mit Pro Tools können Sie Sessions problemlos zwischen Pro Tools|HD und Pro Tools austauschen. 
Die Systeme weisen jedoch einige wichtige Unterschiede auf, die die Art und Weise des 
Materialaustauschs zwischen Sessions beeinflussen.

Nähere Angaben zum Verschieben von Sessions zwischen Windows- und Mac-Systemen finden Sie unter 
„Austauschen von auf verschiedenen Plattformen erstellten Sessions“ auf Seite 389.

Unterschiede zwischen Pro Tools-Systemen

Funktion Avid HDX-Systeme HD Native-Systeme Pro Tools

Maximale Anzahl der 
Audiospuren

bis zu 768 Spuren 
(768 spielbar)

bis zu 768 Spuren 
(256 spielbar)

bis zu 128 Spuren 
(96 spielbar)

Maximale Anzahl der 
Auxiliary-Eingangs-
Spuren

512 Aux-Eingangs-
Spuren

512 Aux-Eingangs-
Spuren

128 Aux-Eingangs-
Spuren

Maximale Anzahl der 
Instrumentenspuren

256 
Instrumentenspuren

256 
Instrumentenspuren

128 
Instrumentenspuren

Maximale Anzahl der 
internen Mix-Busse

256 interne Mix-Busse 256 interne Mix-Busse 256 interne Mix-Busse

Inserts pro Spur bis zu 10 Inserts bis zu 10 Inserts bis zu 10 Inserts

Sends pro Spur bis zu 10 Sends bis zu 10 Sends bis zu 10 Sends
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Öffnen von Pro Tools HD-
Sessions in Pro Tools
Eine Pro Tools HD-Session kann in Pro Tools 
geöffnet werden, wobei jedoch einzelne 
Komponenten der Session auf andere Art oder gar 
nicht geöffnet werden.

Beim Öffnen einer Pro Tools HD 11.x-Session 
in Pro Tools 11.x geschieht Folgendes:

Spuren

• Alle über die ersten 128 hinausgehenden Spuren 
werden deaktiviert.

• Alle über 128 hinausgehenden 
Instrumentenspuren werden deaktiviert.

• Alle über 128 hinausgehenden Auxiliary-
Eingangs-Spuren werden deaktiviert.

• DSP-Plug-Ins mit Native-Äquivalenten werden 
konvertiert, DSP-Plug-Ins ohne Native-
Äquivalente werden deaktiviert.

• Mehrkanal-Surround-Spuren werden aus der 
Session entfernt.

• Nicht verfügbare Ein- und Ausgangspfade 
werden deaktiviert.

• HEAT (wenn vorhanden) wird entfernt.

Gruppen

• Mix-Gruppen behalten nur Main Volume-
Informationen bei.

• Mix/Edit-Gruppen behalten nur Main Volume- 
und Automation Mode-Informationen bei.

• Automation Overflow-Informationen für 
gruppierte Einstellungen werden beibehalten.

• Das Gruppenverhalten von Solos, 
Stummschaltungen, Send-Pegeln, Send-
Stummschaltungen wird beibehalten.

• Solo-Modus- und Solo-Latch-Einstellungen 
werden verworfen.

Video

• Es wird nur der Haupt-Videospur angezeigt.

• Es wird nur der erste QuickTime-Film in der 
Session angezeigt bzw. wiedergegeben.

• Weist die Session QuickTime-Filme in der 
Clipliste auf, jedoch keine Videospur, wird sie 
mit einer neuen QuickTime-Filmspur geöffnet, 
die den ersten QuickTime-Film aus der Clipliste 
enthält.

• Auf der Timeline wird lediglich die zuletzt 
aktive Video-Playlist angezeigt und 
wiedergegeben. Alternative Video-Playlists 
stehen nicht zur Verfügung.

Gemeinsames Nutzen von 
unter verschiedenen 
Pro Tools-Softwareversionen 
erstellten Sessions
Pro Tools ermöglicht die gemeinsame Nutzung von 
Sessions in unterschiedlichen Softwareversionen 
eines bestimmten Pro Tools-Systems. 

Pro Tools 11.x- und 10.x-Sessions können nicht in 
niedrigeren Pro Tools-Versionen geöffnet werden. 
Um eine Pro Tools 11.x- oder 10.x-Session so zu 
speichern, dass sie mit einer niedrigeren Pro Tools-
Version kompatibel ist, muss mit dem Save Copy In-
Befehl das entsprechende Session-Format ausgewählt 
werden.
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Austauschen von Sessions 
zwischen Pro Tools 11.x und 
Pro Tools 10.x
Pro Tools 11.x- und 10.x-Sessions sind 
miteinander kompatibel. Für Sessions mit 64 Bit 
AAX-Plug-Ins, für die es keine 32 Bit-Version 
gibt, werden diese Plug-Ins deaktiviert, wenn die 
Session in Pro Tools 10.x geöffnet wird. 
Gleichfalls werden für Sessions mit 32 Bit AAX-, 
RTAS- und TDM-Plug-Ins ohne 64 Bit-AAX-
Entsprechung diese Plug-Ins deaktiviert, wenn die 
Session in Pro Tools 10.x geöffnet wird.

Außerdem werden bei Sessions, die in 
Pro Tools 11.x erstellt oder bearbeitet wurden, alle 
über 128 hinausgehenden Instrumentenspuren 
inaktiv, wenn die Session in Pro Tools 10.x 
geöffnet wird.

Eine Session, die in Pro Tools 11.x erstellt wurde 
und (aufgrund von Plug-Ins) mehr als 4 GB RAM 
benötigt , kann nicht in Pro Tools 10.x 
geöffnet werden.

Austauschen von Sessions mit Video

Wenn Sie eine Session mit Video in 
Pro Tools 11.x öffnen, die in einer niedrigeren 
Pro Tools-Version erstellt wurde, muss das 
Seitenverhältnis zurückgesetzt werden.

Wenn Sie eine Session in Pro Tools 11.x öffnen, die 
Avid-Video in einer niedrigeren Pro Tools-Version 
enthält, wird die Spur inaktiv. Dies ist nicht der Fall, 
wenn das Avid-Video eine SD-Auflösung hat und ein 
Mojo oder Mojo SDI angeschlossen ist.

Speichern von Pro Tools 11.x- 
bis 10.x-Sessions im Format der 
Pro Tools-Versionen 7 bis 9
Um eine Pro Tools 11.x- oder 10.x-Session so zu 
speichern, dass sie mit den Pro Tools-Versionen 
7.x bis 9.x kompatibel ist, muss mit dem Befehl 
File > Save Copy In das Format Pro Tools 7 -> 

9 Session ausgewählt werden.

Beim Speichern einer Pro Tools 11.x- oder 10.x-
Session im Format der Pro Tools-Versionen 7 
bis 9 geschieht Folgendes:

• Alle über 256 hinausgehenden Audiospuren 
werden deaktiviert.

• Clip-Gain-Einstellungen werden weggelassen. 
Wenn Sie die Clip-Gain-Einstellungen vor dem 
Speichern der Session-Kopie anwenden 
möchten, müssen Sie die Clip-Gain-
Einstellungen manuell rendern.

• Fades müssen gerendert werden, wenn die 
Sessions in einer niedrigeren Pro Tools-Version 
geöffnet werden.

• Bei Sessions mit gemischten Dateiformaten und 
Bitrates müssen alle Dateien in dasselbe 
Dateiformat und dieselbe Bitrate 
konvertiert werden.

• Sessions mit 32-Bit-Gleitkomma-Bitrate 
müssen in 24 Bit oder 16 Bit 
umgewandelt werden.

• Bei Sessions mit RF64-Dateien, die über 4 GB 
groß sind: Diese Dateien können in niedrigeren 
Pro Tools-Versionen nicht genutzt werden. (Sie 
müssen solche Dateien manuell editieren und 
konsolidieren, damit sie in niedrigeren 
Pro Tools-Versionen geöffnet werden können.)
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Öffnen von Pro Tools 9.0-Sessions 
in Pro Tools 8.1 und 8.5
Eine Pro Tools 9.0-Session kann in Pro Tools 8.1 
und 8.5 geöffnet werden, wobei jedoch einzelne 
Komponenten der Session auf andere Art oder gar 
nicht geöffnet werden.

Beim Öffnen einer Pro Tools 9.0-Session in 
Pro Tools 8.1 oder 8.5 geschieht Folgendes: 

• Alle über 256 hinausgehenden Audiospuren 
werden deaktiviert.

• Alle über 128 hinausgehenden internen Mix-
Busse werden deaktiviert.

• Die Stereo-Pan-Tiefe wird auf -2,5 dB 
zurückgesetzt.

Öffnen von Pro Tools 9.0-
Sessions in Pro Tools 8.0
Eine Pro Tools 9.0-Session kann in Pro Tools 8.0 
geöffnet werden, wobei jedoch einzelne 
Komponenten der Session auf andere Art oder gar 
nicht geöffnet werden.

Beim Öffnen einer Pro Tools 9.0-Session in 
Pro Tools 8.0 geschieht Folgendes: 

• Alles, was beim Öffnen einer Pro Tools 9.0-
Session in Pro Tools 8.1 geschieht.

• Ausgangsbus-Zuweisungen werden entfernt.

• HEAT (wenn vorhanden) wird entfernt.

Öffnen von Pro Tools 9.0-
Sessions in Pro Tools 7.4.x
Eine Pro Tools 9.0-Session kann in Pro Tools 
7.4.x geöffnet werden, wobei jedoch einzelne 
Komponenten der Session auf andere Art oder gar 
nicht geöffnet werden.

Beim Öffnen einer Pro Tools 9.0-Session in 
Pro Tools 7.4.x geschieht Folgendes: 

• Alles, was beim Öffnen einer Pro Tools 9.0-
Session in Pro Tools 8.0 geschieht.

• Inserts F–J und jegliche verknüpfte Automation 
werden entfernt.

• Clips aus Audiodateien mit einer Größe von 
über 2 GB werden als offline angezeigt.

• Tonhöhenänderungen von Elastic-Clips werden 
entfernt.

• Akkord-Marker werden entfernt.

Beim Öffnen einer Pro Tools 9.0-Session in 
Pro Tools 8.1 oder 8.5 wird eine Warnung 
darüber ausgegeben, dass eine mit einer 
neueren Version von Pro Tools erstellte 
Session geöffnet wird und dass nicht alle 
Komponenten der Session zur Verfügung 
stehen werden.

Beim Öffnen einer Pro Tools 9.0-Session in 
Pro Tools 8.0 wird eine Warnung darüber 
ausgegeben, dass eine mit einer neueren 
Version von Pro Tools erstellte Session 
geöffnet wird und dass nicht alle 
Komponenten der Session zur Verfügung 
stehen werden.

Beim Öffnen einer Pro Tools 9.0-Session in 
Pro Tools 7.4.x wird eine Warnung darüber 
ausgegeben, dass eine mit einer neueren 
Version von Pro Tools erstellte Session 
geöffnet wird und dass nicht alle 
Komponenten der Session zur Verfügung 
stehen werden.
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Öffnen von in Pro Tools 7.4 oder 
höher erstellten Sessions in 
Pro Tools 7.3.x oder 7.2
Eine in Pro Tools 7.4 bis 9.x oder höher erstellte 
Session kann in Pro Tools 7.3.x oder 7.2 geöffnet 
werden, wobei jedoch einzelne Komponenten der 
Session auf andere Art oder gar nicht 
geöffnet werden.

Wenn Sie eine in Pro Tools 7.4.x oder höher 
erstellte Session in Pro Tools 7.3.x oder 7.2 
öffnen, geschieht Folgendes: 

• Alles, was beim Öffnen einer unter 
Pro Tools 8.x oder höher erstellten Session in 
Pro Tools 7.4.x geschieht.

• Elastic Audio-fähige Spuren werden ohne 
Elastic Audio geöffnet, und Wiedergabedauern 
von Clips werden auf das Timing der 
Originalquelldatei zurückgesetzt.

• Sessions mit gemischten Sprachzeichen, die in 
Unicode unterstützt werden, werden 
möglicherweise nicht geöffnet oder in Pro Tools 
unleserlich angezeigt.

Öffnen von in Pro Tools 7.2 oder 
höher erstellten Sessions in 
Pro Tools 7.1 oder 7.0
Eine in Pro Tools 7.2 bis 9.x erstellte Session ohne 
Videospuren oder VCA-Master kann in 
Pro Tools 7.1 oder 7.0 geöffnet werden, wobei 
jedoch einzelne Komponenten der Session auf 
andere Art oder gar nicht geöffnet werden.

Wenn Sie eine in Pro Tools 7.4 bis 9.x erstellte 
Session in Pro Tools 7.1 oder 7.0 öffnen, 
geschieht Folgendes: 

• Alles, was beim Öffnen einer unter 
Pro Tools 7.4 oder höher erstellten Session in 
Pro Tools 7.3.x oder 7.2 geschieht.

Spuren

• VCA Master-Spuren werden entfernt und 
jegliche nicht addierte VCA-Automation 
wird verworfen.

• Jegliche nicht addierte Trim-Automation 
wird verworfen.

Gruppen

• Alle über die ersten 26 hinausgehenden Gruppen 
(Bank 1, Gruppen a–z) werden verworfen.

• Mix-Gruppen behalten nur Main Volume-
Informationen bei.

• Mix/Edit-Gruppen behalten nur Main Volume- 
und Automation Mode-Informationen bei.

Beim Öffnen einer Pro Tools-Session der 
Versionen 7.4 bis 9.x in Pro Tools 7.3.x wird 
eine Warnung darüber ausgegeben, dass 
eine mit einer neueren Version von Pro Tools 
erstellte Session geöffnet wird und dass nicht 
alle Komponenten der Session zur Verfügung 
stehen werden.

Beim Öffnen einer in Pro Tools 7.4 bis 9.x 
erstellten Session in Pro Tools 7.2, 7.1 oder 
7.0 wird keine Warnung darüber 
ausgegeben, dass nicht alle Komponenten 
der Session zur Verfügung stehen werden.

In Pro Tools HD 7.2 bis 9.x erstellte Sessions 
mit Videospuren oder VCA-Mastern können 
ausschließlich in Pro Tools HD 7.1cs3 und 
höher geöffnet werden.
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• Automation Overflow-Informationen 
für gruppierte Einstellungen werden 
nicht beibehalten.

• Das Gruppenverhalten von Solos, LFEs, 
Stummschaltungen, Send-Pegeln, Send-
Stummschaltungen wird nicht beibehalten.

• Solo-Modus- und Solo-Latch-Einstellungen 
werden verworfen.

Video

• Es wird nur der Haupt-Videospur angezeigt.

• Es wird nur der erste QuickTime-Film in der 
Session angezeigt bzw. wiedergegeben.

• Weist die Session QuickTime-Filme in der 
Clipliste auf, jedoch keine Videospur, wird sie 
mit einer neuen QuickTime-Filmspur geöffnet, 
die den ersten QuickTime-Film aus der Clipliste 
enthält.

• Auf der Timeline wird lediglich die zuletzt 
aktive Video-Playlist angezeigt und 
wiedergegeben. Alternative Video-Playlists 
stehen nicht zur Verfügung.

• Videoclips und Videoclip-Gruppen werden nicht 
angezeigt oder gespeichert.

Öffnen von in Pro Tools HD 7.2 
bis 9.x erstellten Sessions 
in Pro Tools LE 8.0
Eine in Pro Tools HD 7.2 bis 9.x erstellte Session 
ohne Videospuren oder VCA-Master kann in 
Pro Tools LE 8.0 geöffnet werden, wobei jedoch 
einzelne Komponenten der Session auf andere Art 
oder gar nicht geöffnet werden.

Wenn Sie eine in Pro Tools HD 7.x bis 9.x 
erstellte Session in Pro Tools LE 8.0 öffnen, 
geschieht Folgendes:

Spuren

• Alle inaktiven sowie alle über die 
Maximalanzahl von 48 hinausgehenden Spuren 
werden auf Voice Off gesetzt.

• Alle über 32 hinausgehenden Bus-Zuweisungen 
werden deaktiviert.

• Alle über 32 hinausgehenden 
Instrumentenspuren werden deaktiviert.

• TDM-Plug-Ins mit RTAS-Entsprechungen 
werden konvertiert, jene ohne Entsprechungen 
werden deaktiviert.

• Mehrkanal-Surround-Spuren werden aus der 
Session entfernt.

• Nicht verfügbare Ein- und Ausgangspfade 
werden deaktiviert.

• Jegliche Delay Compensation-Einstellungen 
werden aufgehoben.

• VCA Master-Spuren werden entfernt und 
jegliche nicht addierte VCA-Automation wird 
verworfen.

In Pro Tools HD 7.2 oder höher erstellte 
Sessions mit Videospuren oder VCA Master-
Spuren können ausschließlich in 
Pro Tools LE 7.0cs3 und höher 
geöffnet werden.
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• HEAT (sofern vorhanden) wird entfernt (nur 
Sessions aus Pro Tools HD 8.1 und höher mit 
HEAT-Option).

• Ausgangsbus-Zuweisungen werden entfernt 
(nur Pro Tools HD 8.1-Sessions und höher).

Gruppen

• Nur in Pro Tools LE 7.1 oder niedriger werden 
alle über die ersten 26 hinausgehenden Gruppen 
(Bank 1, Gruppen a–z) verworfen.

• Mix-Gruppen behalten nur Main Volume-
Informationen bei.

• Mix/Edit-Gruppen behalten nur Main Volume- 
und Automation Mode-Informationen bei.

• Automation Overflow-Informationen für 
gruppierte Einstellungen werden beibehalten.

• Das Gruppenverhalten von Solos, 
Stummschaltungen, Send-Pegeln, Send-
Stummschaltungen wird beibehalten.

• Solo-Modus- und Solo-Latch-Einstellungen 
werden verworfen.

Video

• Es wird nur der Haupt-Videospur angezeigt.

• Es wird nur der erste QuickTime-Film in der 
Session angezeigt bzw. wiedergegeben.

• Weist die Session QuickTime-Filme in der 
Clipliste auf, jedoch keine Videospur, wird sie 
mit einer neuen QuickTime-Filmspur geöffnet, 
die den ersten QuickTime-Film aus der Clipliste 
enthält.

• Auf der Timeline wird lediglich die zuletzt 
aktive Video-Playlist angezeigt und 
wiedergegeben. Alternative Video-Playlists 
stehen nicht zur Verfügung.

• Nur in Pro Tools LE 7.1 oder niedriger werden 
Videoclips und Videoclip-Gruppen nicht 
angezeigt oder gespeichert.

Speichern von Pro Tools 11.x- 
bis 10.x-Sessions im Format der 
Pro Tools-Versionen 5.1 bis 6.9
Unter Pro Tools 7.x und höher erstellte Sessions 
können nicht in den Pro Tools-Versionen 5.1 bis 
6.9.x geöffnet werden. 

Um eine Pro Tools 11.x- oder 10.x-Session so zu 
speichern, dass sie mit den Pro Tools-Versionen 
5.1 bis 6.9.x kompatibel ist, muss mit dem Befehl 
Save Copy In das Format Pro Tools 5.1 -> 

6.9 Session ausgewählt werden.

Beim Speichern einer Pro Tools 11.x- oder 10.x-
Session in den Pro Tools-Formaten 5.1 bis 6.9 
geschieht Folgendes:

• Alles, was beim Speichern einer Pro Tools 11.x- 
oder 10.x-Session im Format der Pro Tools-
Versionen 7 bis 9 geschieht.

Spuren

• Alle über 256 hinausgehenden Audiospuren 
werden entfernt.

• Alle über 128 hinausgehenden internen Mix-
Busse werden entfernt.

• Ausgangsbus-Zuweisungen werden entfernt.

• HEAT (wenn vorhanden) wird entfernt.

• Elastic Audio-fähige Spuren werden 
untransponiert und ohne Warps gespeichert, und 
Wiedergabedauern von Clips werden auf das 
Timing der Originalquelldatei zurückgesetzt.

Pro Tools 8.x und höher unterstützt Dateigrößen 
bis 3,4 GB und Pro Tools 10 und höher 
unterstützt Dateigrößen über 4 GB. Pro Tools 
5.1 bis 6.9 für Mac unterstützen lediglich 
Dateigrößen bis 2 GB. Falls Ihre Session auf 
Audiodateien verweist, die größer als 2 GB sind, 
sind Clips so zu bearbeiten und 
zusammenzufügen, dass nur auf Dateien 
verwiesen wird, die kleiner als 2 GB sind.
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• Instrumentenspuren werden in separate 
Auxiliary Input- und MIDI-Spuren aufgeteilt.

• VCA Master-Spuren werden entfernt und VCA-
Automation wird mit den entsprechenden Slave-
Spuren addiert.

• Trim-Automation-Playlists werden mit den 
zugehörigen Automation-Playlists addiert.

• Fader Gain-Pegel und Automation Breakpoints 
über +6 dB werden in +6 dB geändert.

• Lange Namen werden auf 31 Zeichen gekürzt.

• Die folgenden Attribute werden verworfen:

• Clipgruppen

• Clip-Loops

• Samplebasierte MIDI-Clips

• Samplebasierte MIDI-Spuren

• Inserts F–J und jegliche verknüpfte 
Automation

• Sends F–J und verknüpfte Automation

• Marker/Memory Locations 201–999

Gruppen

• Alle über die ersten 26 hinausgehenden Gruppen 
(Bank 1, Gruppen a–z) werden verworfen.

• Mix-Gruppen behalten nur Main Volume-
Informationen bei.

• Mix/Edit-Gruppen behalten nur Main Volume- 
und Automation Mode-Informationen bei.

• Automation Overflow-Informationen für 
gruppierte Einstellungen werden 
nicht beibehalten.

• Das Gruppenverhalten von Solos, LFEs, 
Stummschaltungen, Send-Pegeln, Send-
Stummschaltungen wird nicht beibehalten.

• Solo-Modus- und Solo-Latch-Einstellungen 
werden verworfen.

Video

• Es wird nur der Haupt-Videospur angezeigt.

• Es wird nur der erste QuickTime-Film in der 
Session angezeigt bzw. wiedergegeben.

• Weist die Session QuickTime-Filme in der 
Clipliste auf, jedoch keine Videospur, wird sie 
mit einer neuen QuickTime-Filmspur geöffnet, 
die den ersten QuickTime-Film aus der Clipliste 
enthält.

• Auf der Timeline wird lediglich die zuletzt 
aktive Video-Playlist angezeigt und 
wiedergegeben. Alternative Video-Playlists 
stehen nicht zur Verfügung.

• Videoclips und Videoclip-Gruppen werden nicht 
angezeigt oder gespeichert.

Sprachkompatibilität

• Die Limit Character Set-Option muss aktiviert 
sein und Sie müssen eine einzige Sprache und 
einen Zeichensatz auswählen.
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Speichern von Pro Tools 11.x- 
bis 10.x-Sessions im Format der 
Pro Tools-Version 5.0
In Pro Tools 5.1 und höher erstellte Sessions 
können nicht in Pro Tools 5.0 geöffnet werden.

Um eine Pro Tools 11.x- oder 10.x-Session so zu 
speichern, dass sie mit Pro Tools-Version 5.0 
kompatibel ist, muss mit dem Befehl Save Copy In 
das Format Pro Tools 5.0 Session ausgewählt 
werden.

Beim Speichern einer Pro Tools 11.x- oder 10.x-
Session im Pro Tools-Format 5.0 geschieht 
Folgendes:

• Alles, was beim Speichern einer Pro Tools 11.x- 
oder 10.x-Session im Pro Tools 5.0-Format 
geschieht.

• Mehrkanal-Surround-Spuren werden aus der 
Session entfernt.

• Inaktive Spuren werden aus der Session entfernt.

• „No Output“ zugewiesene Spuren werden auf 
die Busse 31 und 32 geroutet.

• Den Bussen 33–64 zugewiesene Spuren oder 
Sends werden auf die Busse 31 und 32 geroutet.

• Mehrkanalpfaden oder deren Unterpfaden 
zugewiesene Spuren werden auf die Busse 31 
und 32 geroutet.

• Sends, die Mehrkanalpfaden oder 
deren Unterpfaden zugewiesen wurden, werden 
verworfen.

• Spuren oder Sends, die auf gerade/ungerade 
Kanäle (etwa 2–3) verweisenden Stereopfaden 
zugewiesen sind, werden auf die Busse 31 und 
32 geroutet.

• Multimono-Plug-In-Instanzen werden verworfen.

Sprachkompatibilität

Unicode-Unterstützung für 
Sprachen
Pro Tools unterstützt überall in der Pro Tools-
Anwendung die Eingabe und Anzeige aller 
Sprachzeichen, die in Unicode unterstützt werden. 
Sie haben dadurch folgende Möglichkeiten:

• Verwenden Sie mehrere Sprachen in Session-
Namen sowie in Pfaden, Dateinamen und 
Clipnamen innerhalb derselben Session.

• Suche nach Begriffen in mehreren Sprachen in 
Workspace-Browsern. 

Pro Tools – Sprache für 
automatische Benennungen
Bei der Arbeit in einer anderen Sprache als 
Englisch kann Pro Tools so eingerichtet werden, 
dass Sessionelemente (wie Clips, Spuren und I/O-
Pfade) automatisch auf Englisch benannt werden. 
Dies ist besonders dann nützlich, wenn Sessions 
mit anderen Anwendern genutzt werden, die auf 
Englisch arbeiten. 

So legen Sie die Sprache für automatische 
Benennungen entsprechend der für die Pro Tools-
Anwendung ausgewählten Sprache fest:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Display-Registerkarte.

2 Wählen Sie im Language-Popup-Menü 
die Sprache aus, die Sie in Pro Tools verwenden 
möchten.

3 Deaktivieren Sie die Default Automatic Naming 

to English-Option.
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Pro Tools – Anwendungssprache
(Nur Windows)

Sie können die Sprache, die Sie in der Pro Tools-
Anwendung verwenden möchten, unabhängig von 
der verwendeten Sprachversion von Windows 
festlegen.

So wählen Sie die Sprache für Pro Tools aus:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Display-Registerkarte.

2 Wählen Sie im Language-Popup-Menü 
die Sprache aus, die Sie in Pro Tools verwenden 
möchten.

Mehrsprachige 
Anwendungsunterstützung 
für Pro Tools-Systeme
(Lokalisiertes Betriebssystem nur auf Mac)

Lokalisierte Versionen von Pro Tools können auf 
einem geeigneten Mac, auf dem die englische und 
entsprechend lokalisierte Version des 
Betriebssystems läuft, geöffnet werden. 
Sie können außerdem eine andere Sprache in einer 
beliebigen lokalisierten Version von Pro Tools 
(einschließlich Englisch) in den 
Apple-Systemeinstellungen auswählen.

So wechseln Sie zu einer anderen Sprachversion 
von Pro Tools:

1 Wenn Pro Tools geöffnet ist, beenden Sie 
das Programm.

2 Öffnen Sie die Apple-Systemeinstellungen.

3 Klicken Sie auf das Flaggensymbol (International).

4 Klicken Sie auf die Language-Registerkarte.

5 Ziehen Sie in der Languages-Spalte die 
gewünschte Sprache an die oberste Stelle in der 
Liste.

6 Schließen Sie das International-Dialogfeld.

7 Sie haben folgende Möglichkeiten:

• Wenn Sie von einer lokalisierten Sprache 
zu Englisch wechseln, starten Sie Pro Tools.

• Wenn Sie von einer lokalisierten Sprache in eine 
andere wechseln (oder von Englisch in eine 
lokalisierte Sprache), melden Sie sich über das 
Apple-Menü ab und wieder an und starten Sie 
Pro Tools.

Soll der Computer mit der ursprünglichen 
Sprache gestartet werden, wiederholen Sie den 
oben beschriebenen Vorgang und ändern Sie 
die International-Systemeinstellung in die 
gewünschte Sprache.



Teil IV: Wiedergabe und
Aufnahme
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Kapitel 19: Wiedergabe von Spuren

Nach dem Importieren oder Aufzeichnen von 
Audio- oder MIDI-Material in Spuren können Sie 
dieses zum Editieren oder Mischen wiedergeben.

Starten und Stoppen der 
Wiedergabe

Wählen Sie eine der folgenden Methoden, um die 
Wiedergabe zu starten:

• Klicken Sie im Transport-Fenster auf „Play“. 

• Drücken Sie die Leertaste.

• Befindet sich der Ziffernblock im Transport- 
oder Shuttle-Modus, drücken Sie die 0 auf dem 
Ziffernblock.

• Befindet sich der Ziffernblock im Transport-
Modus und ist die Option „Use Separate Play 
and Stop Keys“ aktiviert, drücken Sie die 
Eingabetaste auf dem Ziffernblock.

• Ist eine Arbeitsoberfläche oder MIDI-
Bedienoberfläche verbunden und konfiguriert, 
drücken Sie den Play-Schalter.

• Ist Pro Tools online und als Slave an ein anderes 
Deck angeschlossen, drücken Sie „Play“ auf 
dem Master-Deck (siehe „Pro Tools im Online-
Modus“ auf Seite 1216).

Wählen Sie eine der folgenden Methoden, um die 
Wiedergabe anzuhalten:

• Klicken Sie im Transport-Fenster auf „Stop“. 

• Drücken Sie die Leertaste.

• Befindet sich der Ziffernblock im Transport- 
oder Shuttle-Modus, drücken Sie die 0 auf 
dem Ziffernblock.

• Ist eine Bedienoberfläche verbunden und 
konfiguriert, drücken Sie den Stop-Schalter.

• Ist Pro Tools online und als Slave an ein anderes 
Deck angeschlossen, drücken Sie „Stop“ auf 
dem Master-Deck (siehe „Pro Tools im Online-
Modus“ auf Seite 1216).

Wiedergeben von Audio

So geben Sie Audio wieder:

1 Importieren Sie Audio in eine Spur bzw. 
zeichnen Sie Audio in einer Spur auf.

2 Weisen Sie den Output-Selektor der Spur Ihrem 
Haupt-Monitorpfad zu.

3 Um mit der Wiedergabe vom Anfang der 
Session an zu beginnen, klicken Sie im 
Transport-Fenster auf „Return to Zero“.

4 Starten Sie die Wiedergabe.

5 Die Audiowiedergabe erfolgt über den 
ausgewählten Ausgangspfad. Stellen Sie 
Lautstärke- und Pan-Fader der Spur nach 
Bedarf ein.

6 Halten Sie die Wiedergabe nach Beendigung 
des Vorgangs an.

Weitere Informationen zu den Ziffernblockmodi 
finden Sie unter „Ziffernblockmodus“ auf 
Seite 28.
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MIDI-Wiedergabe

So geben Sie MIDI wieder (und hören die 
Audioaufnahme ab): 

1 Importieren Sie MIDI in eine Instrumenten- 
oder MIDI-Spur, zeichnen Sie es dort auf, oder 
geben Sie es dort ein.

2 Gehen Sie bei einer Instrumentenspur 
folgendermaßen vor:

• Stellen Sie den Output-Selektor der 
Instrumentenspur auf den Haupt-Monitorpfad 
ein.

• Wenn Sie ein Instrumenten-Plug-In verwenden, 
fügen Sie das Plug-In auf der Spur ein. Der 
MIDI Output-Selektor der Spur (im 
Instruments-Bedienfeld) sollte automatisch dem 
Plug-In zugewiesen werden.

• Wenn Sie ein externes MIDI-Gerät verwenden 
(kein Instrumenten-Plug-In), stellen Sie den MIDI 
Output-Selektor im Instruments-Bedienfeld auf 
das MIDI-Gerät (bzw. den -Anschluss) und den 
Kanal für die Wiedergabe ein.

• Wenn Sie ein externes MIDI-Gerät verwenden 
(kein Instrumenten-Plug-In), stellen Sie den 
Input-Selektor der Instrumentenspur auf den 
Eingangspfad ein, mit dem die Audioausgänge 
des MIDI-Geräts verbunden ist.

3 Gehen Sie bei einer MIDI-Spur 
folgendermaßen vor:

• Wenn Sie ein Instrumenten-Plug-In verwenden, 
erstellen Sie eine Auxiliary-Eingangs- oder 
Instrumentenspur, um das Instrumenten-Plug-In 
auf der Spur einzufügen.

• Wenn Sie ein externes MIDI-Gerät verwenden 
(kein Instrumenten-Plug-In), erstellen Sie eine 
Auxiliary-Eingangs- oder Instrumentenspur zum 
Abhören des Audiomaterials aus einem externen 
MIDI-Gerät oder Instrumenten-Plug-In.

• Wenn Sie ein externes MIDI-Gerät verwenden 
(kein Instrumenten-Plug-In), stellen Sie den 
Input-Selektor der Auxiliary-Eingangs- oder 
Instrumentenspur auf den Eingangspfad ein, mit 
dem die Audioausgaben des MIDI-Geräts 
verbunden ist.

• Stellen Sie den Output-Selektor der Auxiliary-
Eingangs- oder Instrumentenspur auf den 
Haupt-Monitorpfad ein.

• Stellen Sie den Output-Selektor der MIDI-Spur 
auf das Instrumenten-Plug-In oder das MIDI-
Gerät (Anschluss) und den Kanal für die 
Wiedergabe ein.

4 Um mit der Wiedergabe vom Anfang der 
Session an zu beginnen, klicken Sie im 
Transport-Fenster auf „Return to Zero“.

5 Starten Sie die Wiedergabe.

6 Es wird das ausgewählte MIDI-Gerät 
wiedergegeben, und die Audioaufnahme aus 
dem MIDI-Gerät wird über den ausgewählten 
Ausgangspfad auf der Auxiliary-Eingangs- 
oder Instrumentenspur abgehört. Stellen Sie 
Lautstärke- und Pan-Fader der MIDI-, 
Auxiliary-Eingangs- oder Instrumentenspur 
nach Bedarf ein.

7 Halten Sie die Wiedergabe nach Beendigung 
des Vorgangs an.

Informationen zur Synchronisation externer 
MIDI-Geräte mit Pro Tools für die Wiedergabe 
und Aufnahme anhand von MIDI Beat Clock 
finden Sie unter „MIDI Beat Clock“ auf 
Seite 423. Informationen zur Verwendung von 
MIDI-Timecode finden Sie unter „Erzeugen 
von Timecode“ auf Seite 1217.
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Wiedergabeposition
Die Wiedergabeposition ist der Punkt auf der 
Pro Tools-Timeline, an dem mit der Wiedergabe 
von Audio oder MIDI in einer Session begonnen 
werden kann.

Die Wiedergabeposition wird in den Zählern und 
Anzeigen im Edit-, Transport- und Big Counter-
Fenster angezeigt. Die Wiedergabeposition (oder 
Edit-Selektion) wird außerdem durch einen 
Playback- oder Edit-Cursor in der Timeline oder 
Playlist des Edit-Fensters angezeigt.

Darüber hinaus bietet Pro Tools außerdem ein Pre-
Roll-Steuerelement zur Einstellung des 
Wiedergabebeginns vor der Wiedergabeposition. 
Siehe „Grundlegende Transport-Steuerelemente 
und -Zähler“ auf Seite 179.

Zähler und Anzeigen, die die 
Wiedergabeposition angeben

Haupt- und Nebenzähler und Edit-Selektions-
Anzeigen

Oben im Edit-Fenster wird die 
Wiedergabeposition in den Haupt- und 
Nebenzählern (Main/Sub Counters) sowie in der 
Edit-Selektions-Start-Anzeige angegeben. Wird 
keine Selektion vorgenommen, wird die 
Wiedergabeposition auch in der Edit-Selektions-
End-Anzeige dargestellt.

Zähler und Edit-Selektions-Anzeigen können auch 
im Transport-Fenster angezeigt werden.

So zeigen Sie den Hauptzähler im Transport-
Fenster an:

 Wählen Sie View > Transport > Counters. 

So zeigen Sie den Nebenzähler im Transport-
Fenster an:

1 Wählen Sie View > Transport > Counters.

2 Wählen Sie View > Transport > Expanded.

So zeigen Sie Edit-Selektions-Anzeigen im 
Transport-Fenster an:

 Wählen Sie View > Transport > Expanded.

Der Big Counter

Die aktuelle Wiedergabeposition lässt sich auch 
im Big Counter anzeigen.

So zeigen Sie den Big Counter an:

 Wählen Sie Window > Big Counter.

Hauptzähler und Nebenzähler (Main und Sub), Edit-
Selektions-Anzeigen

Transport-Fenster mit Zählern

Klicken Sie im Transport-Fenster bei 
gedrückter Ctrl-Taste (Mac) oder Windows-
Taste (Windows) auf die Schaltfläche 
„Expand/Collapse“, um die Zähler 
anzuzeigen oder auszublenden.

Klicken Sie im Transport-Fenster bei 
gedrückter Wahltaste (Mac) oder Alt-Taste 
(Windows) auf die Schaltfläche 
„Expand/Collapse“, um die Zähler und MIDI-
Steuerelemente anzuzeigen oder 
auszublenden.

Big Counter-Fenster
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Cursor zur Anzeige der 
Wiedergabeposition (oder 
Bearbeitungsposition)
Im Edit-Fenster von Pro Tools gibt es zwei 
Cursorarten zur Anzeige der aktuellen 
Wiedergabe- bzw. Edit-Selektion:

Playback-Cursor

Der Playback-Cursor ist eine durchgehende Linie, 
die sich über das Edit-Fenster bewegt, um die 
aktuelle Wiedergabeposition anzuzeigen.

Das Scrollen des Edit-Fensters und die 
Funktionsweise des Playback-Cursors werden von 
der ausgewählten Scrolling-Option bestimmt. 
Weitere Hinweise finden Sie unter „Scrolling-
Optionen“ auf Seite 413.

Edit-Cursor

Der Edit-Cursor ist eine blinkende Linie, 
die angezeigt wird, wenn Sie mit dem Selector-Tool 
in die Playlist einer Spur klicken. Der blinkende 
Edit-Cursor zeigt den Startpunkt für alle 
Editiervorgänge an. Wenn Sie einen Abschnitt 
selektieren und einen Editiervorgang ausführen, ist 
nur der selektierte Abschnitt betroffen.

Auffinden des Playback-Cursors 
außerhalb des Bildschirmbereichs

Mit dem Playback-Cursor-Locator finden Sie den 
Playback-Cursor außerhalb des Bildschirmbereichs.

Befindet sich der Playback-Cursor hinter dem im 
Edit-Fenster sichtbaren Zeitbereich, wird der 
Playback-Cursor-Locator am rechten Rand der 
Haupt-Zeitbasis-Leiste angezeigt. Befindet sich der 
Playback-Cursor vor dem im Edit-Fenster sichtbaren 
Zeitbereich, wird der Playback-Cursor-Locator am 
linken Rand der Haupt-Zeitbasis-Leiste angezeigt.

Wenn beispielsweise Audiomaterial über den im 
Edit-Fenster sichtbaren Bereich hinaus abgespielt 
wird und im Bereich „Scrolling Option“ die Option 
„None“ aktiviert ist, bewegt sich der Playback-
Cursor aus dem im Edit-Fenster sichtbaren Bereich. 
Dann wird der Playback-Cursor-Locator am rechten 
Rand der Haupt-Zeitbasis-Leiste eingeblendet.

Der Playback-Cursor-Locator ist rot, wenn eine Spur 
aufnahmebereit ist. Der Playback-Cursor-Locator ist 
blau, wenn keine Spur aufnahmebereit ist.

So finden Sie den Playback-Cursor außerhalb des 
Bildschirmbereichs:

 Klicken Sie in der Haupt-Zeitbasis-Leiste auf 
den Playback-Cursor-Locator.

Der Playback-Cursor wird im Edit-Fenster 
angezeigt.

Playback-Cursor-Locator, Aufnahme aktiviert 
(Playback-Cursor befindet sich hinter dem 
angezeigten Audiobereich)
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Festlegen der 
Wiedergabeposition
Pro Tools stellt Befehle für unterschiedliche 
Möglichkeiten des Festlegens oder Verschiebens 
der Wiedergabeposition in einer Session bereit. 
Dazu gehören das Auffinden einer Passage in 
einem Song, das Übergehen zu einem anderen 
Abschnitt in einer Anordnung und das Vergleichen 
verschiedener Abschnitte.

Festlegen der 
Wiedergabeposition mit dem 
Selector-Tool
Um festzulegen, wo die Wiedergabe beginnen soll, 
klicken Sie mit dem Selector-Tool auf die 
gewünschte Stelle der Spur. (Voraussetzung 
hierfür ist, dass Edit- und Timeline-Selektion 
gekoppelt sind.) Informationen hierzu finden Sie 
unter „Koppeln und Entkoppeln von Timeline- 
und Edit-Selektionen“ auf Seite 575.

So starten Sie die Wiedergabe an einer 
bestimmten Position innerhalb einer Spur:

1 Vergewissern Sie sich, dass Options > Link 

Timeline and Edit Selection aktiviert ist.

2 Klicken Sie mit dem Selector-Tool auf die 
Stelle in einer Spur, an der die Wiedergabe 
beginnen soll.

3 Starten Sie die Wiedergabe.

4 Halten Sie die Wiedergabe an.

So springen Sie an eine andere Position und 
starten dort die Wiedergabe:

 Wenn die Wiedergabe angehalten ist, klicken 
Sie mit dem Selector-Tool auf den Punkt, an 
dem die Wiedergabe beginnen soll, und klicken 
Sie im Transport-Fenster auf „Play“.

 Klicken Sie während der Wiedergabe auf die 
neue Position in einer Zeitbasis-Leiste.

Wenn Timeline- und Edit-Selektion miteinander 
gekoppelt sind, können Sie mit dem Time 
Grabber-Tool auf einen Clip oder eine MIDI-Note 
klicken, um die Timeline automatisch mit der 
Startzeit der Selektion zu aktualisieren. So können 
Sie von diesem Punkt aus mit der Wiedergabe 
beginnen.

Festlegen der 
Wiedergabeposition mit 
grundlegenden Transport-
Steuerelementen
Transport-Steuerelemente im Transport-Fenster 
und oben im Edit-Fenster können zum 
Verschieben der Wiedergabeposition verwendet 
werden. Dazu gehören Rewind, Fast Forward 
sowie Return to Zero (zum Verschieben der 
Wiedergabeposition an den Beginn der Session). 
Weitere Informationen finden Sie unter 
„Grundlegende Transport-Steuerelemente und -
Zähler“ auf Seite 179.Bestimmen eines Wiedergabepunkts mit dem 

Selector-Tool
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Festlegen der 
Wiedergabeposition mit dem 
Hauptzähler oder der Edit-
Selektions-Start-Anzeige

So legen Sie die Wiedergabeposition anhand 
eines Hauptzählers (oder der Edit-Selektions-
Start-Anzeige) fest:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf einen der beiden Zähler.

• Drücken Sie die Sternchentaste (*) auf dem 
Ziffernblock, um den Hauptzähler im Edit-
Fenster (oder den Hauptzähler im Transport-
Fenster bzw. dem Big Counter-Fenster, wenn 
diese angezeigt werden) zu markieren.

2 Geben Sie die neue Position ein. Um von einem 
Zeitfeld ins nächste zu gelangen, drücken Sie 
die Punkt-Taste (.).

3 Durch Drücken der Eingabetaste wird der neue 
Wert akzeptiert und Sie gelangen automatisch 
an die neue Position.

Festlegen der 
Wiedergabeposition mit Fast 
Forward/Rewind
Mithilfe der Fast Forward- und Rewind-
Schaltflächen im Transport-Fenster können Sie die 
Wiedergabeposition verschieben. Wenn in den 
Operation-Voreinstellungen die Option Audio 

During Fast Forward/Rewind aktiviert ist, können 
Sie während des Spulens, ähnlich wie bei einem 
CD-Player, Audiomaterial abhören.

Sie können auch schrittweise vor- und 
zurückspulen, indem Sie wiederholt auf die 
jeweilige Schaltfläche klicken. Die Größe dieser 
Schritte wird in der Zeitskala festgelegt:

Bars|Beats – der Cursor wird auf den Beginn des 
nächsten bzw. vorangegangenen Takts bewegt.

Min:Sec – der Cursor wird in Schritten von 
1 Sekunde vorwärts bzw. rückwärts bewegt.

Timecode – der Cursor wird in Schritten von 
1 Sekunde vorwärts bzw. rückwärts bewegt (unter 
Anpassung an das aktuelle SMPTE-Format).

Feet+Frames – der Cursor wird in Schritten von 
1 Fuß (30,48 cm) vorwärts bzw. rückwärts bewegt.

Samples – der Cursor wird in Schritten von 
1 Sekunde vorwärts bzw. rückwärts bewegt.

Festlegen der 
Wiedergabeposition mit Back- 
und Forward-Befehlen
(Nur Pro Tools HD)

Pro Tools bietet vier Back/Forward-Befehle 
(manchmal „Rollback“ genannt) zum Verschieben 
der Wiedergabeposition im Edit-Fenster. 

Sie können die Wiedergabeposition auch durch 
Wiederholen des Befehls in mehreren Schritten 
verschieben (siehe „Wiederholen von Back-
/Forward-Befehlen“ auf Seite 411).

Back – verschiebt die Wiedergabeposition um den 
Wert von „Back/Forward Amount“ zurück.

Back and Play – verschiebt die aktuelle 
Wiedergabeposition um den Wert von 
„Back/Forward Amount“ zurück und beginnt 
automatisch mit der Wiedergabe.

Forward – verschiebt die Wiedergabeposition 
um den Wert von „Back/Forward Amount“ 
nach vorne.

Forward and Play – verschiebt die aktuelle 
Wiedergabeposition um den Wert von 
„Back/Forward Amount“ nach vorne und beginnt 
automatisch mit der Wiedergabe.

Back/Forward-Befehle eignen sich auch 
für das Steuern eines 9-Pin-Geräts. 
Detaillierte Informationen finden Sie im 
MachineControl-Handbuch.
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Festlegen von „Back/Forward Amount“

Die Länge der Verschiebebewegung (zurück oder 
vorwärts) wird durch die Back/Forward Amount-
Einstellung auf der Operation-Registerkarte 
(Setup > Preferences) festgelegt.

So konfigurieren Sie „Back/Forward Amount“:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

Die Zeitbasis der Back/Forward Amount-
Einstellung folgt standardmäßig der Zeitskala. Sie 
können jedoch „Follow Main Time“ deaktivieren 
und eines der folgenden Zeitbasis-Formate 
selektieren:

• Bars|Beats

• Min:Sec

• Timecode

• Feet+Frames

• Samples

2 Sie haben folgende Möglichkeiten:

• Wählen Sie im Back/Forward Amount-Popup-
Menü einen Voreinstellungswert.

• Geben Sie im Back/Forward Amount-Feld einen 
anwenderdefinierten Wert ein.

Verwenden der Back- und Forward-Befehle

So verschieben Sie die Wiedergabeposition um 
den Wert von Back/Forward Amount zurück:

 Klicken Sie im Transport-Fenster bei 
gedrückter Befehlstaste (Mac) oder Strg-Taste 
(Windows) auf „Rewind“.

So verschieben Sie die Wiedergabeposition um 
den Wert von „Back/Forward Amount“ vorwärts:

 Klicken Sie im Transport-Fenster bei 
gedrückter Befehlstaste (Mac) oder Strg-Taste 
(Windows) auf „Fast Forward“.

So verschieben Sie die Wiedergabeposition um 
den Wert von Back/Forward Amount zurück und 
beginnen dann die Wiedergabe:

 Drücken Sie Befehl + Wahl (Mac) oder Strg + 
Alt (Windows) und klicken Sie im Transport-
Fenster auf „Rewind“.

So verschieben Sie die Wiedergabeposition um 
den Wert von Back/Forward Amount vorwärts und 
beginnen dann die Wiedergabe:

 Drücken Sie Befehl + Wahl (Mac) oder Strg + 
Alt (Windows) und klicken Sie im Transport-
Fenster auf „Fast Forward“.

Wiederholen von Back-/Forward-Befehlen

Alle Back-/Forward-Befehle können wiederholt 
werden, um die Gesamtlänge der Vorwärts- oder 
Rückwärtsbewegung zu erhöhen.

So wiederholen Sie Vorwärts- oder 
Rückwärtsbewegungen:

1 Halten Sie die Befehlstaste (Mac) bzw. die Strg-
Taste (Windows) gedrückt.

2 Klicken Sie so oft auf „Rewind“ oder „Fast 
Forward“, wie Sie die Wiedergabeposition 
rückwärts oder vorwärts um den in 
„Back/Forward Amount“ festgelegten Wert 
verschieben möchten.

Erweitern von Selektionen mit Back- oder Back 
and Play-Befehlen

Sie können die Befehle Back und Back and Play 
verwenden, um eine Selektion rückwärts um den 
Wert von „Back/Forward Amount“ zu erweitern. 

Obwohl Sie eine Selektion nicht mit den 
Befehlen „Forward“ und „Forward and 
Play“ erweitern können, können Sie die 
folgenden Vorgänge mit „Forward“ oder 
„Forward and Play“ verwenden, um die 
Startposition einer aktuellen Selektion zu 
verschieben.
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So erweitern Sie eine Selektion mit Back- oder 
Back and Play-Befehlen:

1 Legen Sie den Wert von „Back/Forward 
Amount“ fest. (Siehe „Festlegen von 
„Back/Forward Amount““ auf Seite 411.)

2 Ziehen Sie mit dem Selector-Tool innerhalb 
einer Spur, um eine Selektion vorzunehmen.

3 Sie haben folgende Möglichkeiten:

• Um die Selektion rückwärts um den Wert von 
„Back/Forward Amount“ zu erweitern, drücken 
Sie Umschalt + Befehl (Mac) bzw. Umschalt + 
Strg (Windows) und klicken Sie im Transport-
Fenster auf „Rewind“.

• Um die Selektion rückwärts um den Wert von 
„Back/Forward Amount“ zu erweitern und dann 
die Wiedergabe zu beginnen, drücken Sie 
Umschalt + Befehl + Wahl (Mac) bzw. 
Umschalt + Strg + Alt (Windows) und klicken 
Sie im Transport-Fenster auf „Rewind“.

Weitere Möglichkeiten zum 
Verschieben der 
Wiedergabeposition
Sie können die Wiedergabeposition auch 
folgendermaßen verschieben:

Shuttle Lock-Modi – mit den beiden Shuttle Lock-
Modi („Classic“ oder „Transport“) können Sie den 
Ziffernblock verwenden, um mit einer bestimmten 
Geschwindigkeit vor- oder zurückzuspulen. 
Weitere Informationen finden Sie unter „Shuttle 
Lock-Modi“ auf Seite 28.

Memory Location-Liste – Memory Locations 
können zum Verschieben der Wiedergabeposition 
(oder Edit-Selektion) verwendet werden. Beim 
Aufrufen einer Memory Location wird die 
Wiedergabeposition (oder Edit-Selektion) 
aktualisiert. Sie können Memory Locations über 
das Memory Locations-Fenster oder über den 
Ziffernblock aufrufen. Marker Memory Locations 
können außerdem durch Anklicken in der 
Markers-Leiste aufgerufen werden. Weitere 
Informationen finden Sie unter „Aufrufen von 
Memory Locations“ auf Seite 843.

Springen zu Signalspitzen – bei aktivierter Tab to 
Transients-Schaltfläche können Sie in 
Audiowellenformen automatisch zu Signalspitzen 
navigieren, indem Sie den Cursor kurz vor den 
Beginn eines Spitzenwerts platzieren. Weitere 
Informationen finden Sie unter „Springen zu 
Signalspitzen“ auf Seite 587.
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Scrolling-Optionen
Sie können konfigurieren, wie der Inhalt des Edit-
Fensters während der Wiedergabe und dem 
Aufzeichnen scrollt. 

So konfigurieren Sie die Optionen für das Scrollen:

 Wählen Sie Options > Scrolling und wählen Sie 
eine der folgenden Optionen:

None – das Edit-Fenster wird weder während noch 
nach der Wiedergabe gescrollt. Der Playback-
Cursor bewegt sich durch das Edit-Fenster und 
zeigt die Wiedergabeposition an.

After Playback – der Playback-Cursor bewegt sich 
durch das Edit-Fenster und zeigt die 
Wiedergabeposition an. Wenn die Wiedergabe 
angehalten wird, scrollt das Edit-Fenster an die 
letzte Wiedergabeposition.

Page – der Playback-Cursor bewegt sich durch das 
Edit-Fenster und zeigt die Wiedergabeposition an. 
Wenn der rechte Rand des Edit-Fensters erreicht 
ist, wird sein gesamter Inhalt durchblättert und der 
Playback-Cursor bewegt sich weiter vom linken 
zum rechten Fensterrand. Weitere Informationen 
finden Sie unter „Scrollen der Seite während 
der Wiedergabe“ auf Seite 413.

Continuous (Nur Pro Tools HD) Siehe 
„Continuous Scrolling During Playback“ auf 
Seite 414.

Center Playhead (nur Pro Tools HD) Siehe 
„Center Playhead-Scrolling“ auf Seite 414.

Scrollen der Seite während 
der Wiedergabe
Sie können Pro Tools so konfigurieren, dass die 
Spurenanzeige während der Wiedergabe 
gescrollt wird und der Edit-Cursor immer an dem 
Punkt angezeigt wird, an dem die Wiedergabe 
angehalten wird.

So stellen Sie die Spurenanzeige und den Edit-
Cursor so ein, dass stets der momentan 
wiedergegebene Abschnitt dargestellt wird:

 Aktivieren Sie im Edit-Fenster die Timeline 
Insertion/Play Start Marker Follows Playback-
Schaltfläche.

Der Page Scroll- oder Continuous Scroll-Modus 
wird deaktiviert, wenn Sie in der Timeline oder 
Playlist eine Selektion treffen oder manuell in 
der Timeline scrollen. Klicken Sie in der Haupt-
Zeitbasis-Leiste auf den Playback-Cursor-
Locator, um in den Page Scroll-Modus 
zurückzukehren (siehe „Auffinden des Playback-
Cursors außerhalb des Bildschirmbereichs“ auf 
Seite 408).

Schaltfläche „Timeline Insertion/Play Start Marker 
Follows Playback“ aktiviert

Sie können die TimelineInsertion/Play Start 
Marker Follows Playback-Option in den 
Operation-Voreinstellungen aktivieren oder 
deaktivieren.

Drücken Sie Ctrl + N (Mac) bzw. Windows + 
N (Windows), um zwischen Aktivierung und 
Deaktivierung der Option „Timeline 
Insertion/Play Start Marker Follows 
Playback“ zu wechseln.
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Continuous Scrolling During 
Playback
(Nur Pro Tools HD)

Wenn diese Scrolling-Option aktiviert ist, wird 
kontinuierlich durch den Inhalt des Edit-Fensters 
hinter dem Playback-Cursor gescrollt, der immer 
in der Mitte des Fensters verbleibt. Bei dieser 
Option basiert die Wiedergabe (anders als bei der 
Scrolling-Option Center Playhead) immer auf der 
Timeline-Selektion. 

Continuous Scrolling During Playback beansprucht 
Host-Verarbeitungsleistung. Verwenden Sie diese 
Option in hostbasierten Pro Tools-Systemen daher 
nur, wenn dies absolut erforderlich ist.

Center Playhead-Scrolling
(Nur Pro Tools HD)

Wenn diese Scrolling-Option aktiviert ist, wird 
kontinuierlich durch den Inhalt des Edit-Fensters 
hinter dem Playhead gescrollt, der durch eine 
blaue Linie (bei Aufnahme durch eine rote) in der 
Mitte des Fensters dargestellt wird.

Der Playhead zeigt an, wo die Wiedergabe beginnt, 
wenn Sie im Transport-Fenster auf „Play“ klicken.

Um den Playhead für die Wiedergabe an eine 
bestimmte Stelle zu bewegen, können Sie über 
eine Leiste dorthin scrollen (siehe „Scrollen in 
einer Zeitbasis-Leiste“ auf Seite 590), die 

horizontale Bildlaufleiste im Edit-Fenster 
benutzen oder die gewünschte Position in einer der 
Edit-Selektions-Anzeigen oder einen Zähler 
eingeben.

Die Timeline-Selektion wird durch die 
Positionsänderung nicht aktualisiert. Wenn Sie 
jedoch die Timeline-Selektion aktualisieren, 
springt der Playhead automatisch zum Timeline-
Einfügepunkt.

Bei aktiviertem Playhead können Sie Timeline-
Selektionen anfahren und wiedergeben. Weitere 
Hinweise finden Sie unter „Wiedergeben von 
Timeline- und Edit-Selektionen mit dem 
Playhead“ auf Seite 417.

Halbes Edit-Fenster
Ist die Scrolling-Option auf Continuous oder 

Center Playhead festgelegt, wird das Edit-Fenster 
(vor Beginn der Session) nur in der linken Hälfte 
des Bildschirms dargestellt, wenn sich der 
Playhead am Beginn der Session befindet.

Scrolling-Option „Center Playhead“

Center Playhead-Scrolling und Dynamic 
Transport-Modus können nicht gleichzeitig 
verwendet werden. Bei Auswahl von Center 
Playhead-Scrolling wird der Dynamic 
Transport-Modus deaktiviert (sofern er 
aktiviert ist). Analog wird bei Aktivierung des 
Dynamic Transport-Modus die Scrolling-
Option automatisch deaktiviert, wenn Center 
Playhead-Scrolling ausgewählt wurde.

Halbes Fenster für die Scrolling-Option „Center 
Playhead“
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Wiedergeben von Selektionen
Nachdem Sie eine Edit-Selektion vorgenommen 
haben, können Sie sie abhören, indem Sie im 
Transport-Fenster auf „Play“ klicken. Falls Sie die 
Abschnitte für Pre- und Post-Roll aktiviert haben, 
werden diese ebenfalls abgespielt.

So geben Sie eine Selektion wieder:

1 Aktivieren Sie Options > Link Timeline and Edit 
Selection.

2 Nehmen Sie mit dem Selector- oder Time 
Grabber-Tool eine Spurselektion vor.

3 Wenn Sie Pre-Roll oder Post-Roll verwenden 
möchten, aktivieren Sie die entsprechenden 
Einstellungen und geben Sie die benötigten 
Werte ein. Weitere Hinweise finden Sie unter 
„Einstellen von Pre- und Post-Roll“ auf 
Seite 463.

4 Klicken Sie im Transport-Fenster auf „Play“ 
oder drücken Sie die Leertaste.

Alle Spuren geben den ausgewählten Abschnitt 
wieder, inklusive Pre-Roll und Post-Roll, falls 
diese Funktion aktiviert wurde.

So geben Sie eine Edit-Selektion bei deaktivierter 
Option „Link Timeline and Edit Selection“ wieder:

 Wählen Sie Edit > Selection > Play Edit.

So geben Sie eine Edit-Selektion bei deaktivierter 
Option „Link Timeline and Edit Selection“ wieder:

 Wählen Sie Edit > Selection > Play Timeline.

Abhören von Pre-Roll und Post-
Roll
Sie können auch nur das Pre- und Post-Roll-
Material einer Selektion wiedergeben.

So spielen Sie Material vom Pre-Roll-Punkt bis 
zum Startpunkt einer Selektion oder bis zur 
aktuellen Cursor-Position ab:

 Drücken Sie Wahl + Pfeil nach links (Mac) bzw. 
Alt + Pfeil nach links (Windows).

So geben Sie das Material vom Ende einer 
Selektion oder von der aktuellen Cursor-Position 
bis zum Post-Roll-Punkt wieder:

 Drücken Sie Befehl + Pfeil nach rechts (Mac) 
bzw. Strg + Pfeil nach rechts (Windows).

Abhören von Start- und 
Endpunkten einer Selektion
Gelegentlich möchten Sie vielleicht nur den Start- 
und Endpunkt einer Selektion abhören, nicht die 
gesamte Selektion. Auf diese Weise können Sie 
etwa schnell überprüfen, ob der Anfang oder das 
Ende einer Selektion störende Klick- oder 
Knackgeräusche enthält.

So hören Sie den Startpunkt einer Selektion ab:

 Drücken Sie Befehl + Pfeil nach links (Mac) 
bzw. Strg + Pfeil nach links (Windows).

Wiedergabebereiche beim Abhören von Start- und 
Endpunkten

Spielt den Anfang
(für Post-Roll-Bereich)

Spielt Pre-Roll + 
Anfang

Spielt das Ende
(für Pre-Roll-Bereich)

Spielt Ende + 
Post-Roll
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Wenn Sie den Anfang einer Selektion abhören, 
wird vom Startpunkt aus ein Abschnitt 
wiedergegeben, dessen Länge dem eingestellten 
Post-Roll-Wert entspricht.

So hören Sie den Startpunkt einer Selektion mit 
Pre-Roll ab:

 Drücken Sie Befehl + Wahl + Pfeil nach links 
(Mac) bzw. Strg + Alt + Pfeil nach links 
(Windows).

So hören Sie den Endpunkt einer Selektion ab:

 Drücken Sie Wahl + Pfeil nach rechts (Mac) 
bzw. Alt + Pfeil nach rechts (Windows).

Wenn Sie das Ende einer Selektion abhören, startet 
die Wiedergabe vor dem Endpunkt der Selektion 
und ist so lang wie der eingestellte Pre-Roll-Wert.

So hören Sie den Endpunkt einer Selektion mit 
Post-Roll ab:

 Drücken Sie Befehl + Wahl + Pfeil nach rechts 
(Mac) bzw. Strg + Alt + Pfeil nach rechts 
(Windows).

Transport-Fade-In
Pro Tools enthält eine Fade-in-Option für den 
Transport. Aktivieren Sie diese Option, um die 
Pegel für alle Quellaudiospuren gleichmäßig 
einzublenden; von null bis auf die aktuellen 
Quellaudiopegel zu Beginn des Transports. Die 
Fade-In-Zeiten variieren zwischen 0,000 und 
4,000 Sekunden. Diese Option ist nützlich, um 
Knack- und Klickgeräusche oder einen plötzlichen 
Anstieg der Lautstärke zu verhindern, wenn die 
Wiedergabeposition während der Wiedergabe 
gewechselt wird. 

Verwenden Sie für Musikproduktionsszenarien 
kürzere Fade-In-Zeiten (250 ms). In gewissen 
Postproduktions-Szenarien sollten Sie, falls mit 
externen Decks synchronisiert wird, längere Fade-
In-Zeiten verwenden. Dies hängt ganz davon ab, 
wie lange alle synchronisierten Decks zum 
Synchronisieren mit dem Timecode benötigen (bis 
zu 2 Sekunden).

So aktivieren (bzw. deaktivieren) Sie die Fade-In-
Transport-Option:

1 Öffnen Sie das „Expanded Transport“-Fenster.

2 Klicken Sie auf die Fade-in-Option, um diese 
zu aktivieren (bzw. zu deaktivieren). 

So stellen die Fade-In-Zeit für den Transport ein:

1 Öffnen Sie das „Expanded Transport“-Fenster.

2 Klicken Sie auf das Zahlenfeld rechts neben der 
Schaltfläche zum Aktivieren des Fade-In. 

3 Geben Sie die gewünschte Zeit ein.

4 Drücken Sie Return (Mac) oder Eingabe 
(Windows).

Transport-Fenster mit aktiviertem Fade-In (2 Sekunden)

Vergewissern Sie sich, dass die „Fade-In“-
Transport-Option während der Aufnahme 
deaktiviert ist. Audiodaten, die bei aktivierter 
„Fade-In“-Transport-Option aufgenommen 
werden, enthalten einen Fade, der auf der 
eingegebenen Fade-In-Dauer beruht.

Fade-In-Zeit

Fade-In-
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Wiedergeben von Timeline- 
und Edit-Selektionen mit dem 
Playhead
(Nur Pro Tools HD)

Wenn die Scrolling-Option auf Center Playhead 
festgelegt ist, wird durch Selektionen in der 
Timeline nicht festgelegt, an welcher Position die 
Wiedergabe beginnt. Der Playhead selbst zeigt an, 
wo die Wiedergabe beginnt. 

Timeline- und Edit-Selektionen können jedoch 
auch bei aktiviertem Playhead wiedergegeben 
werden.

So geben Sie eine Edit-Selektion bei aktiviertem 
Playhead wieder:

1 Deaktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Wählen Sie Options > Scrolling > Center Playhead.

3 Nehmen Sie mit dem Selector- oder Time 
Grabber-Tool eine Spurselektion vor.

4 Wählen Sie Edit > Selection > Play Edit.

So geben Sie eine Timeline-Selektion bei 
aktiviertem Playhead wieder:

1 Deaktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Wählen Sie Options > Scrolling > Center 

Playhead.

3 Ziehen Sie mit dem Selector-Tool in einer 
beliebigen Zeitbasis-Leiste, um den 
Wiedergabebereich festzulegen.

4 Wählen Sie Edit > Selection > Play Timeline.

Verschieben des Playhead
Ist die Scrolling-Option auf Center Playhead 
festgelegt, kann der Playhead nach vorne oder 
hinten an die nächste Clipgrenze in der selektierten 
Spur verschoben werden.

So bewegen Sie den Playhead über die 
Clipgrenzen einer Spur hinweg:

1 Deaktivieren Sie die Tab to Transients-
Schaltfläche (siehe „Springen zu Signalspitzen“ 
auf Seite 587).

2 Klicken Sie mit dem Selector-Tool auf die Spur.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie die Tab-Taste, um den Playhead zur 
nächsten Clipgrenze zu verschieben.

• Drücken Sie Wahl + Tab (Mac) bzw. Strg + Tab 
(Windows), um den Playhead zurück an die 
vorherige Clipgrenze zu verschieben.

Wiedergabemodi
Pro Tools bietet mehrere Wiedergabemodi: 

• Normaler Wiedergabemodus

• Wiedergabe mit halber Geschwindigkeit

• Prime for Playback-Modus

• Loop Playback-Modus

• Dynamic Transport-Modus

Normaler Wiedergabemodus
Der normale Wiedergabemodus liegt vor, wenn 
kein anderer Wiedergabemodus ausgewählt 
wurde. Im normalen Wiedergabemodus erfolgt die 
Wiedergabe in Pro Tools mit der Session-
Samplerate.
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Wiedergabe mit halber 
Geschwindigkeit
Die Wiedergabe mit halber Geschwindigkeit 
eignet sich zum Abhören oder Transkribieren 
schwieriger Passagen auf aufgenommenen Spuren.

So erfolgt die Wiedergabe mit halber 
Geschwindigkeit:

1 Sie haben folgende Möglichkeiten:

• Halten Sie die Umschalttaste gedrückt und 
klicken Sie im Transport-Fenster auf die Play-
Schaltfläche.

• Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Play-Schaltfläche und 
wählen Sie Half-Speed. Klicken Sie danach auf 
„Play“, um die Wiedergabe mit halber 
Geschwindigkeit zu starten.

2 Klicken Sie im Transport-Fenster auf „Stop“, 
um die Wiedergabe anzuhalten.

Prime for Playback-Modus
Bei der Wiedergabe einer großen Anzahl von 
Spuren kann es eine Weile dauern, bis Pro Tools 
die Wiedergabe startet. Um diese Verzögerung zu 
vermeiden, schalten Sie Pro Tools vor Beginn der 
Wiedergabe in den Prime for Playback-Modus.

So aktivieren Sie den Prime for Playback-Modus 
und starten die Wiedergabe:

1 Sie haben folgende Möglichkeiten:

• Um Pro Tools in den Prime for Playback-Modus 
zu versetzen, klicken Sie bei gedrückter 
Wahltaste (Mac) oder Alt-Taste (Windows) in 
das Transport-Fenster. 

• Klicken Sie mit der rechten Maustaste auf die 
Play-Schaltfläche und wählen Sie Prime for 

Playback.

Die Stop-Schaltfläche leuchtet und die Play-
Schaltfläche blinkt.

2 Um sofort mit der Wiedergabe zu beginnen, 
klicken Sie auf „Play“. 

3 Klicken Sie auf „Stop“, um die Wiedergabe 
anzuhalten.

Loop Playback-Modus
Ist der Loop Playback-Modus aktiviert, wird der 
selektierte Abschnitt der Spur im Loop 
wiedergegeben. Wurde keine Selektion 
vorgenommen, startet die Wiedergabe 
normalerweise an der aktuellen Cursor-Position. 

Das Abspielen im Loop eignet sich beim Arbeiten 
mit Musikmaterial sehr gut zur Überprüfung der 
rhythmischen Kontinuität einer Selektion. Wenn 
Sie mit eintaktigen Selektionen arbeiten, können 
Sie testen, ob das Material sauber geloopt wird. 
Wenn Sie rhythmische Sprünge hören, sollten 
Sie die Länge Ihrer Selektion so lange anpassen, 
bis der Abschnitt musikalisch in den Kontext der 
Playlist und der anderen Spuren passt.

Sie können auch durch Drücken der 
Umschalt- und Leertaste mit halber 
Geschwindigkeit wiedergeben.

Verwenden Sie bei der Synchronisation 
mit Timecode den Prime for Playback-
Modus, um eine große Anzahl von Spuren 
wiederzugeben. Auf diese Weise wird die Zeit 
verkürzt, die für das Verankern mit dem 
Timecode benötigt wird.

Eine Selektion muss mindestens 
500 Millisekunden lang sein, damit sie 
im Loop wiedergegeben werden kann.
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So geben Sie eine Selektion im Loop wieder:

1 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Selektieren Sie mit dem Selector-Tool den 
Abschnitt, den Sie im Loop wiedergeben möchten.

3 Führen Sie einen der folgenden Schritte aus, um 
die Loop-Wiedergabe zu aktivieren:

• Aktivieren Sie Options > Loop Playback. 

• Klicken Sie mit der rechten Maustaste auf die 
Play-Schaltfläche im Transport-Fenster und 
wählen Sie im Popup-Menü Loop.

• Klicken Sie im Transport-Fenster bei gedrückter 
Ctrl-Taste (Mac) oder Windows-Taste 
(Windows) auf „Play“. 

• Drücken Sie Befehl + Umschalt + L (Mac) bzw. 
Strg + Umschalt + L (Windows).

• Befindet sich der Ziffernblock im Transport-
Modus, können Sie auch die 4 auf dem 
Ziffernblock drücken.

Wenn diese Option aktiviert wurde, erscheint ein 
Loop-Symbol in der Play-Schaltfläche im 
Transport-Fenster.

4 Klicken Sie im Transport-Fenster auf „Play“.

Die Wiedergabe wird am Pre-Roll-Punkt gestartet 
(wenn Pre-Roll aktiviert ist), bis zum Ende der 
Selektion fortgesetzt und beginnt erneut am 
Startpunkt der Selektion.

5 Klicken Sie im Transport-Fenster auf „Stop“, 
um die Wiedergabe anzuhalten.

„Loop Playback“ und Audioaufnahme

Die Wiedergabe im Loop aktiviert nicht die Loop-
Aufnahme. Verwenden Sie den Loop-
Aufnahmemodus, um während der Aufnahme 
Loops zu verwenden (siehe „Loop-Aufnahme von 
Audiomaterial“ auf Seite 470).

Dynamic Transport-Modus
Im Dynamic Transport-Modus können Sie die 
Wiedergabeposition von der Timeline-Selektion 
entkoppeln. Dies bedeutet, dass Sie die Wiedergabe 
von einem beliebigen Punkt auf der Timeline starten 
können, ohne dass Ihre Timeline- oder Edit-
Selektion verloren geht. Sie können beispielsweise 
den Dynamic Transport-Modus in Verbindung mit 
dem Loop Playback-Modus verwenden, um Loop-
Übergänge schnell abzuhören.

Bei aktiviertem Dynamic Transport-Modus wird 
die Haupt-Zeitbasis-Leiste auf die doppelte Höhe 
erweitert und der Wiedergabestart-Marker wird 
sichtbar. Der Wiedergabestart-Marker legt fest, wo 
die Wiedergabe bei aktiviertem Transport beginnt. 
Sie können den Wiedergabestart-Marker 
unabhängig von der Timeline-Selektion platzieren. 
Der Wiedergabestart-Marker lässt sich während der 
Wiedergabe neu platzieren, wonach die Wiedergabe 
ab dem neuen Punkt fortgesetzt wird.

Loop Playback-Option aktiviert
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Um den Dynamic Transport-Modus zu aktivieren 
oder deaktivieren, wählen Sie eine der folgenden 
Methoden:

 Aktivieren oder deaktivieren Sie Options > 
Dynamic Transport.

 Klicken Sie mit der rechten Maustaste auf die 
Play-Schaltfläche im Transport-Fenster und 
wählen Sie im Popup-Menü Dynamic Transport.

 Drücken Sie Befehl + Ctrl + P (Mac) bzw. 
Strg + Windows + P (Windows), um den 
Dynamic Transport-Modus zu aktivieren bzw. 
zu deaktivieren.

Um den Wiedergabestart-Marker neu zu platzieren, 
wählen Sie eine der folgenden Methoden:

 Klicken Sie bei ausgewähltem Edit-Tool in das 
Feld des Wiedergabestart-Markers in der 
Haupt-Zeitbasis-Leiste.

 Ziehen Sie den Wiedergabestart-Marker bei 
ausgewähltem Edit-Tool an eine neue Position.

 Klicken Sie im Transport-Fenster auf „Fast 
Forward“ oder „Rewind“, um die Position des 
Wiedergabestart-Markers um das 
standardmäßige Fast Forward- bzw. Rewind-
Inkrement zu ändern.

So ändern Sie den Start- bzw. Endmarker der 
Timeline-Selektion:

1 Nehmen Sie mit dem Selector-Tool durch Klicken 
und Ziehen in der Haupt-Zeitbasis-Leiste eine 
Timeline-Selektion vor. Bei aktivierter Link 

Timeline and Edit Selection-Option können Sie 
eine Edit-Selektion mit dem Selector-Tool oder 
einem der Grabber-Tools vornehmen.

2 Ziehen Sie bei ausgewähltem Edit-Tool 
entweder den Start- oder Endmarker der 
Timeline-Selektion nach links oder rechts, 
wodurch die Timeline-Selektion erweitert bzw. 
verkleinert wird.

Beim Aktivieren des Dynamic Transport-
Modus werden automatisch „Link Timeline 
and Edit Selection“ deaktiviert und der Loop 
Playback-Modus aktiviert.

Center Playhead-Scrolling (nur Pro Tools 
HD) und Dynamic Transport-Modus können 
nicht gleichzeitig verwendet werden. Bei 
Auswahl von Center Playhead-Scrolling 
wird der Dynamic Transport-Modus 
deaktiviert (sofern er aktiviert ist). Analog 
wird bei Aktivierung des Dynamic Transport-
Modus die Scrolling-Option automatisch 
deaktiviert, wenn Center Playhead-Scrolling 
ausgewählt wurde.

Dynamic Transport-Modus, Wiedergabestart-Marker 
wird bei erweiterter Haupt-Zeitbasis-Leiste angezeigt

Wiedergabestart-Markerfeld

Timeline-Selektion:
Wiedergabestart-Marker

Doppelklicken Sie auf eine beliebige Stelle im 
Feld des Wiedergabestart-Markers auf der 
Haupt-Zeitbasis-Leiste, um den 
Wiedergabestart-Marker an diese Stelle zu 
verschieben und die Wiedergabe zu starten.

Änderungen in der Timeline-Selektion 
während der Wiedergabe führen zu kurzen 
Wiedergabeunterbrechungen. Um derartige 
Unterbrechungen zu minimieren, verringern 
Sie im Playback Engine-Dialogfeld die AAE 
Playback-Puffergröße.
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So verschieben Sie die Timeline-Selektion:

 Ziehen Sie bei ausgewähltem Edit-Tool die 
Selektion auf der Haupt-Zeitbasis-Leiste an 
eine neue Position.

Play Start Marker Follows Timeline Selection

– ist diese Option aktiviert, wird der 
Wiedergabestart-Marker am Startpunkt 
der Timeline-Selektion ausgerichtet, wenn Sie die 
Timeline-Selektion verschieben, eine neue 
Timeline-Selektion vornehmen oder den 
Startpunkt der Timeline-Selektion anpassen. 
Bei deaktivierter Option werden Wiedergabestart-
Marker und Timeline-Selektion nicht gleichzeitig 
verschoben.

So wird der Wiedergabestart-Marker jederzeit am 
Startpunkt der Timeline-Selektion ausgerichtet:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf Operation-Registerkarte.

3 Aktivieren Sie Play Start Marker Follows 

Timeline Selection.

4 Klicken Sie auf OK.

Timeline Insertion/Play Start Marker Follows 
Playback

Bei aktivierter Option wird der Wiedergabestart-
Marker an den Punkt auf der Timeline verschoben, 
an dem die Wiedergabe angehalten wird. Bei 
deaktivierter Option wird der Wiedergabestart-
Marker nicht abhängig von der Wiedergabe 
verschoben. 

In anderen Modi als dem Dynamic Transport-
Modus folgt der Timeline Insertion-Marker der 
Wiedergabe.

So folgen Timeline Insertion-Marker und 
Wiedergabestart-Marker der Wiedergabe:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf Operation-Registerkarte.

3 Aktivieren Sie Timeline Insertion/Play Start 

Marker Follows Playback.

4 Klicken Sie auf OK.

Dynamic Transport-Modus, Verschieben der Edit-
Selektion

Wenn die Option „Link Timeline and Edit 
Selection“ deaktiviert ist, klicken Sie bei 
gedrückter Wahltaste (Mac) oder Alt-Taste 
(Windows) und ziehen Sie die Timeline-
Selektion, bis die Edit-Selektion an der 
Timeline-Selektion ausgerichtet ist, und 
verschieben Sie dann beides gleichzeitig.

Drücken Sie Ctrl + N (Mac) bzw. Windows + 
N (Windows), um zwischen Aktivierung und 
Deaktivierung der Option „Timeline 
Insertion/Play Start Marker Follows 
Playback“ zu wechseln.
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Verwenden des Dynamic 
Transport-Modus mit „Loop 
Playback“
Verwenden Sie den Dynamic Transport-Modus 
zusammen mit „Loop Playback“, um den Start- 
und Endpunkt für den Loop mit der Timeline-
Selektion festzulegen, während mit dem 
Wiedergabestart-Marker der Wiedergabebeginn 
festgelegt wird. Dies ist besonders hilfreich für das 
Abhören von Loop-Übergängen. Beachten Sie, 
dass bei Aktivierung des Dynamic Transport-
Modus der Loop Playback-Modus automatisch 
aktiviert wird.

So hören Sie einen Loop-Übergang ab:

1 Aktivieren Sie den Dynamic Transport-Modus.

2 Vergewissern Sie sich, dass der Loop Playback-
Modus aktiviert ist.

3 Nehmen Sie eine Timeline-Selektion mit 
Loop vor.

4 Platzieren Sie den Wiedergabestart-Marker vor 
den Out-Punkt der Timeline-Selektion.

5 Starten Sie die Wiedergabe.

Die Wiedergabe wird vor dem Endpunkt des 
Loops gestartet und über den Loop-Punkt hinaus 
bis zum Loop-Start fortgesetzt. Sie können Start- 
und Endmarker der Timeline-Selektion neu 
positionieren, indem Sie darauf klicken und sie 
nach links oder rechts ziehen. Dies ist auch 
während der Wiedergabe möglich. 

Verwenden getrennter 
Wiedergabe- und Stopptasten
Wenn die Use Separate Play and Stop Keys-
Option aktiviert ist, können Sie die Wiedergabe 
mit der Eingabetaste starten und mit der Taste 0 
auf dem Ziffernblock anhalten. Dies ist für das 
schnelle Starten und Anhalten der Wiedergabe 
beim Abhören von Loop-Übergängen hilfreich.

So verwenden Sie separate Wiedergabe- und 
Stopptasten auf dem Ziffernblock:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf Operation-Registerkarte.

3 Wählen Sie für Numeric Keypad die Transport-
Option.

4 Aktivieren Sie Use Separate Play and 

Stop Keys.

5 Klicken Sie auf OK.

Mit der Eingabetaste wird die Wiedergabe 
gestartet. Mit der Taste 0 wird die Wiedergabe 
angehalten. Durch zweimaliges Drücken der Taste 
0 wird der Wiedergabestart-Marker an den Start 
der Timeline-Selektion verschoben.

Dynamic Transport-Modus, Abhören des Loop-
Übergangs

Durch diese Option wird die Verwendung der 
Eingabetaste zum Hinzufügen von Memory 
Location-Markern außer Kraft gesetzt. 
Drücken Sie die Punkt-Taste (.) und danach die 
Eingabetaste auf dem Ziffernblock, um einen 
Memory Location-Marker hinzuzufügen.
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Tastenkombinationen für die 
Umpositionierung des 
Wiedergabestart-Markers
Im Dynamic Transport-Modus können Sie 
Tastenkombinationen verwenden, um den 
Wiedergabestart-Marker entweder während der 
Wiedergabe oder bei angehaltenem Transport neu 
zu positionieren. 

So verschieben Sie den Wiedergabestart-Marker 
an den Start der Timeline-Selektion:

 Drücken Sie die Punkt-Taste (.) auf dem 
Ziffernblock und danach den Nach-links-Pfeil.

So verschieben Sie den Wiedergabestart-Marker 
an das Ende der Timeline-Selektion:

 Drücken Sie die Punkt-Taste (.) auf dem 
Ziffernblock und danach den Nach-rechts-Pfeil.

So verschieben Sie den Wiedergabestart-Marker 
an den Start der Edit-Selektion:

 Drücken Sie die Punkt-Taste (.) auf dem 
Ziffernblock und danach den Nach-unten-Pfeil.

So verschieben Sie den Wiedergabestart-Marker 
an die Position des Playhead:

 Drücken Sie die Punkt-Taste (.) auf dem 
Ziffernblock und danach den Nach-oben-Pfeil.

So verschieben Sie den Wiedergabestart-
Marker mit der Nudge-Funktion nach 
hinten (Zurückspulen):

 Drücken Sie die Taste 1 auf dem Ziffernblock.

So verschieben Sie den Wiedergabestart-Marker 
mit der Nudge-Funktion nach vorne (Vorspulen):

 Drücken Sie die Taste 2 auf dem Ziffernblock.

So verschieben Sie den Wiedergabestart-Marker 
an einen bestimmten Takt:

 Wählen Sie „Bars|Beats“ als Haupt-Zeitbasis-
Leiste aus und tun Sie Folgendes auf dem 
Ziffernblock:

• Drücken Sie das Sternchen (*).

• Geben Sie die Taktnummer ein.

• Drücken Sie die Eingabetaste.

Aufnehmen im Dynamic 
Transport-Modus
Bei Aufnahmen im Dynamic Transport-Modus 
können Sie die Wiedergabe unabhängig von der 
Timeline-Selektion starten. Verwenden Sie den 
Wiedergabestart-Marker als manuelles Pre-Roll 
vor der Timeline-Selektion. Bei Aufnahmen 
erfolgen Punch-In und Punch-Out auf Grundlage 
der Timeline-Selektion. 

MIDI Beat Clock
Pro Tools kann MIDI Beat Clock-Signale 
übermitteln, um externe MIDI-Geräte, die 
das MIDI Beat Clock-Signal empfangen 
(beispielsweise Drum Machines, 
Hardwaresequenzer oder Akkordauflöser), für die 
Wiedergabe und Aufnahme mit dem Tempo der 
Pro Tools-Session zu synchronisieren. Auch 
einige Instrumenten-Plug-Ins unterstützen die 
MIDI Beat Clock für eine Synchronisation mit 
dem Pro Tools-Tempo.

Informationen zur Synchronisation externer 
MIDI-Geräte mit Pro Tools für die 
Wiedergabe und Aufnahme anhand von 
MIDI Timecode finden Sie unter „Erzeugen 
von Timecode“ auf Seite 1217.
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Übermitteln der Beat Clock

So übermitteln Sie MIDI Beat Clock:

1 Wählen Sie Setup > MIDI > MIDI Beat Clock.

2 Wählen Sie im MIDI Beat Clock-Dialogfeld die 
Enable MIDI Beat Clock-Option.

3 Wählen Sie die Geräte aus, die MIDI Beat 
Clock empfangen sollen. Wenn Ihr MIDI-
Interface Übertragungen von MIDI Beat Clock-
Signalen an mehrere Ports nicht unterstützt, 
erscheint das Interface als einziges Zielgerät.

4 Geben Sie die richtigen negativen Offsetwerte 
(wie –200 Samples) für jeden Port ein, der für 
die Übermittlung von MIDI Beat Clock 
aktiviert ist (siehe „Messen der Beat Clock-
Latenz“ auf Seite 425).

5 Klicken Sie auf OK.

Senden von MIDI Beat Clock 
über IAC
(Nur Mac)

Sie können andere MIDI-Anwendungen, für die 
der IAC-Treiber (Apple Inter-Application 
Communication) verwendet wird, mit Pro Tools 
synchronisieren, indem Sie MIDI Beat Clock auf 
dem IAC-Bus übermitteln.

So übermitteln Sie MIDI Beat Clock über den IAC-
Bus:

1 Wählen Sie Setup > MIDI > MIDI Studio.

2 Doppelklicken Sie im Fenster mit den MIDI-
Geräten der Audio-MIDI-Konfiguration auf das 
Symbol für den IAC-Treiber. 

3 Konfigurieren Sie die Anschlüsse für den IAC-
Treiber und vergewissern Sie sich, dass er 
online ist.

4 Wählen Sie Setup > MIDI > MIDI Beat Clock.

5 Wählen Sie im MIDI Beat Clock-Dialogfeld die 
Option Enable MIDI Beat Clock.

6 Wählen Sie die IAC-Treiberanschlüsse aus, 
die Sie für das Senden von MIDI Beat Clock 
aktivieren möchten.

7 Klicken Sie auf OK.
MIDI Beat Clock-Dialogfeld
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MIDI Beat Clock-Offsets
Sie können portweise ein Offset von MIDI Beat 
Clock für das MIDI-Interface und externe MIDI-
Geräte festlegen. So können Sie das Timing für 
jedes Gerät anpassen, wenn einige Geräte aufgrund 
von unterschiedlichen, festen Latenzen verzögert 
klingen. Geben Sie ggf. negative Offsetwerte 
zu Samples für jeden Port ein, um die Audiosignale 
von den externen MIDI-Geräten richtig mit der 
Pro Tools-Wiedergabe zu synchronisieren. 

Messen der Beat Clock-Latenz

So bestimmen Sie das richtige MIDI Beat Clock-
Offset für ein externes MIDI-Gerät:

1 Stellen Sie sicher, dass der Computer und das 
externe MIDI-Gerät richtig verbunden und für 
MIDI konfiguriert sind. Zudem muss der 
Audioausgang richtig mit den Audioeingängen 
des Pro Tools-Audiointerface verbunden sein.

2 Vergewissern Sie sich, dass das externe MIDI-
Gerät für den Empfang der MIDI Beat Clock 
konfiguriert ist und dass es richtig konfiguriert 
ist für die Wiedergabe eines einfachen 
rhythmischen Musters „im Takt“.

3 Erstellen Sie eine neue Pro Tools-Session.

4 Stellen Sie im MIDI Beat Clock-Dialogfeld 
sicher, dass MIDI Beat Clock aktiviert und das 
Gerät ausgewählt ist.

5 Stellen Sie die Haupt-Zeitskala auf 
„Bars|Beats“ ein.

6 Erstellen Sie eine neue Audiospur und wählen 
Sie die Audioeingangskanäle für das externe 
MIDI-Gerät aus.

7 Schalten Sie die Audiospur scharf und beginnen 
Sie mit der Aufnahme. Die MIDI Beat Clock 
wird an das externe MIDI-Gerät gesendet, das 
dann mit der Wiedergabe des Musters beginnt.

8 Beenden Sie die Aufnahme nach einigen Takten.

9 Aktivieren Sie sowohl „Snap to Grid“ als auch 
„Show Grid“.

10 Platzieren Sie mit dem Selector-Tool den Edit-
Cursor auf dem Schlagraster vor einer 
markanten Signalspitze in der Wellenform, die 
„im Takt“ ist. 

11 Aktivieren Sie „Tab to Transients“ und 
wechseln Sie mit Umschalt- und Tab-Taste zu 
der Signalspitze. Die Dauer dieser Selektion 
entspricht ungefähr der Latenz für Ihr externes 
MIDI-Gerät.

12 Ändern Sie „Main Time Scale“ auf „Samples“. 
Die Länge des selektierten Clips in Samples 
entspricht der MIDI Beat Clock-Latenz für das 
Gerät.

13 Geben Sie im MIDI Beat Clock-Dialogfeld den 
Sample Offset-Wert als negative Zahl ein.
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Messen des Offsets für MIDI Beat Clock in Samples

MIDI Beat Clock mit Sample-Offset

Da MIDI nicht samplegenau ist, sollten Sie mehrere Messungen an unterschiedlichen 
Rasterpositionen vornehmen und daraus einen Mittelwert bilden, um den optimalen Wert für das 
MIDI Beat Clock-Offset zu bestimmen.

Nachdem Sie die Latenz für die MIDI Beat Clock-fähigen Geräte gemessen haben, müssen Sie 
diese Werte aufzeichnen, falls Sie den Sample Offset-Wert für MIDI Beat Clock in anderen 
Sessions erneut eingeben müssen.
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Kapitel 20: Aufnahme-Setup

Bevor Sie mit der Aufnahme in Pro Tools 
beginnen, müssen Sie Ihr Pro Tools-System, eine 
Session und mindestens eine Spur für die 
Aufnahme einrichten. Außerdem müssen Sie 
konfigurieren, wie Pro Tools den Eingang, den Sie 
aufnehmen möchten, abhört. 

In diesem Kapitel sind einige Informationen zur 
Vorbereitung für das Aufnehmen von MIDI 
enthalten. Ausführlichere Informationen zum 
Einrichten von MIDI-Aufnahmen finden Sie in 
Kapitel 22: „MIDI-Aufnahme“.

Informationen zu Audioaufnahmen finden Sie 
unter Kapitel 21: „Audioaufnahme“.

Aufnahme-Setup – Übersicht
Das Aufnahme-Setup umfasst die folgenden 
Themen:

Hardware-Setup für die Aufnahme

• „Konfigurieren von Pro Tools-Hardware-I/O für 
die Aufnahme“ auf Seite 428

• „Anschließen einer Audioquelle“ auf Seite 430

Session-Setup für die Aufnahme

• Konfigurieren einer neuen oder bestehenden 
Session für die Aufnahme:

• „Arbeiten mit Festplatten für die Aufnahme“ 
auf Seite 445

• „Aufnehmen mit dem Metronom“ auf 
Seite 430

• „Festlegen von Taktart und Tempo“ auf 
Seite 433

• Einrichten eines Aufnahmemodus: Siehe 
„Aufnahmemodi“ auf Seite 436

Spuren-Setup für die Aufnahme

• Konfigurieren mindestens einer Spur für 
die Aufnahme:

• „Konfigurieren von Standardnamen für 
Audiodateien und -Clips“ auf Seite 439

• „Zuweisen von Hardware-I/O auf einer Spur“ 
auf Seite 441

• „Scharfschalten von Spuren“ auf Seite 442

• „Aufnehmen mit mehreren Festplatten“ auf 
Seite 445

Monitoring-Setup für die Aufnahme

• „Auswählen eines Record Input Monitoring-
Modus“ auf Seite 448

• „Festlegen des Abhörpegels für Aufnahme und 
Wiedergabe“ auf Seite 450

• „Senken der Monitoring-Latenz“ auf Seite 451

• „Aufnehmen mit Verzögerungsausgleich“ auf 
Seite 452

Informationen zur Digitalisierung 
(Aufnahme) von Videomaterial in Pro Tools 
finden Sie in Kapitel 52: „Video in Pro Tools“ 
oder im Avid Video Peripherals Guide.



Pro Tools-Referenzhandbuch428

Konfigurieren von Pro Tools-
Hardware-I/O für die 
Aufnahme
Bevor Sie mit der Aufnahme beginnen, stellen 
Sie sicher, dass die Pro Tools-Systemhardware 
richtig angeschlossen und konfiguriert wurde. 
Informationen zum Anschließen von Pro Tools an 
die Studioausrüstung sowie zur Konfiguration der 
Hardware im Hardware Setup-Dialogfeld 
finden Sie in dem im Lieferumfang des Systems 
enthaltenen Benutzerhandbuch. Informationen 
zum Routen von Signalpfaden in Pro Tools finden 
Sie unter Kapitel 7: „I/O-Setup“.

Eingangsanschlüsse und 
Audiopegel
Avid HD-Audio-Interfaces verwenden den 
nominalen Signalpegel und bieten keine 
Vorverstärkung. Quellen mit niedrigem Pegel, wie 
etwa Mikrofone und elektrische Gitarren, müssen 
vorverstärkt werden. Verwenden Sie hierfür 
entweder ein professionelles Mischpult oder einen 
speziellen Vorverstärker (etwa PRE).

003 Rack+ verfügt über acht vorverstärkte 
Eingänge zum Anschluss von Signalen mit 
niedrigen Pegeln.

003 und 003 Rack verfügen über vier Eingänge 
mit Vorverstärkern, an die Sie Signale mit 
niedrigem Pegel anschließen können, sowie über 
vier zusätzliche Line-Eingänge mit verstellbarer 
Verstärkung.

Eleven Rack verfügt über einen vorverstärkten 
Mic-Eingang und über einen Gitarreneingang 
(Instrumentenpegel) mit einem speziellen 
Schaltkreis mit variabler Impedanz namens True-
Z. (Weitere Informationen hierzu finden Sie im 
Eleven Rack-Benutzerhandbuch.)

Mbox (3. Generation), Mbox 2, Mbox Pro, 
Mbox 2 Pro, Mbox Mini und Mbox 2 Mini 
verfügen über zwei vorverstärkte Eingänge zum 
Anschluss von Signalen mit niedrigen Pegeln.

Lautstärke- und Pan-Regler für Spuren in 
Pro Tools steuern bei allen Systemen nur 
die Monitoring-Pegel, nicht aber die 
Eingangsverstärkung für die Aufnahme. Die LED-
Pegelanzeigen der HD-Audio-Interfaces 
(wie HD I/O oder HD OMNI) zeigen sowohl das 
voll ausgesteuerte Signal (den höchsten Pegel 
vor der Übersteuerung) als auch die reale 
Übersteuerung von Pro Tools-Ausgangssignalen 
an. Die Bildschirmanzeigen in Pro Tools 
zeigen nur die reale Übersteuerung bei der 
Aufnahme auf die Festplatte an. In Pro Tools kann 
eine Übersteuerung am Eingangs- und 
Ausgangswandler Ihres Audio-Interface auftreten 
sowie beim Aufnehmen in eine Datei mit einer 
festen Bitrate (nur 16 oder 24 Bit, bei 32-Bit-
Gleitkomma wird nicht übersteuert).

Digitale Übersteuerung (Clipping)

Clipping tritt auf, wenn Sie ein Signal an einen 
Rekorder bzw. an ein Mischpult senden, der bzw. 
das lauter, als das Gerät erlaubt. Aufgrund der 
Band-Komprimierung kann dem Sound auf vielen 
analogen Bandmaschinen mithilfe einer leichten 
Übersteuerung ein wahrnehmbar wärmerer Klang 
verliehen werden. Bei einer digitalen Aufnahme 
führt die Übersteuerung jedoch zu unerwünschten 
digitalen Verzerrungen. Dies sollte auf jeden Fall 
vermieden werden. 

 PRE kann direkt von einer Pro Tools-Session 
aus ferngesteuert werden.
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Festlegen von Eingangspegeln

Stellen Sie beim Senden eines Signals an ein 
Audio-Aufzeichnungssystem (etwa Pro Tools) 
sicher, dass der Eingangspegel so angepasst ist, 
dass der Dynamikbereich und das Verhältnis von 
Signalen zu Störgeräuschen in der 
aufgenommenen Datei optimiert werden. Wenn 
der Eingangspegel zu niedrig ist, können Sie den 
Dynamikbereich Ihres Pro Tools-Systems nicht 
voll ausnutzen. Ist der Eingangspegel zu hoch, 
kann es zur Übersteuerung und zu einer verzerrten 
Aufnahme kommen. Stellen Sie die Eingangspegel 
hoch ein, aber nicht so hoch, dass es zu einer 
Übersteuerung kommt.

Allgemein gilt: Versuchen Sie, die Pegel so 
einzustellen, dass ihr Spitzenpegel auf der 
Eingangsanzeige zwischen –3 dB und –12 dB liegt, 
ohne dass die Übersteuerungsanzeige des Audio-
Interface ausgelöst wird. Abhängig von der Art des 
Materials, das Sie aufnehmen, sowie dessen 
Dynamikbereich und Spitzenpegel sollten Sie mit 
höheren oder niedrigeren Pegeln aufnehmen.

Sie können die Eingangspegel einer Spur über die 
Lautstärke-Anzeige anzeigen. Normalerweise ist 
diese Anzeige als Peak-Lautstärkeanzeige 
festgelegt. Außerdem können Sie die Headroom-
Anzeige benutzen, um den Peak-Pegel des 
Eingangssignals mit der vorhandenen 
Aussteuerungsreserve zu vergleichen.

So zeigen Sie den Spitzenpegel einer Spur an:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) oder Befehlstaste (Mac) auf die 
Lautstärkeanzeige einer Spur, um die 
verschiedenen Anzeigemodi „Volume“ 
(Lautstärke) und „Channel Delay“ 
(Kanalverzögerung) durchzugehen, bis die 
Anzeige den Spitzenpegel (pk) anzeigt.

Headroom-Anzeige

Pro Tools bietet eine numerische Anzeige (in dB) 
des verfügbaren Headroom für Spuren, basierend 
auf dem letzten gemessenen Sample-Peak-Pegel 
im Verhältnis zum Referenzpegel des derzeit 
ausgewählten Anzeigetyps. Die Headroom-
Anzeige befindet sich im Mix-Fenster unter den 
Fadern und Anzeigen rechts neben 
der Lautstärkenanzeige. Klicken Sie auf die 
Headroom-Anzeige, um den derzeitigen Wert 
zurückzusetzen.

Erscheint die Headroom-Anzeige in blau, 
werden Werte unterhalb des DB-Werts 
gemessen, der als der niedrigste Pegel für den 
derzeit ausgewählten Anzeigetyp festgelegt ist.

Klicken Sie bei gedrückter Wahltaste (Mac) 
bzw. Alt-Taste (Windows), um sämtliche 
Headroom-Anzeigen zurückzusetzen. Halten 
Sie die Umschalt- sowie die Wahltaste (Mac) 
bzw. Alt-Taste (Windows) gedrückt und 
klicken Sie, um die Headroom-Anzeigen nur 
für ausgewählte Spuren zurückzusetzen.

Lautstärke- und Headroom-Anzeige

Headroom-Anzeige

Lautstärkenanzeige
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Calibration Mode
(Nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme)

Sie können den Calibration-Modus in Pro Tools 
verwenden, um die Eingangs- und Ausgangspegel 
Ihres Audio-Interface an die Pegel Ihres Mischpults 
und anderer Audiogeräte Ihres Studios anzupassen.

HD I/O verfügt über einen Satz einstellbarer 
Trimm-Potentiometer für Ein- und Ausgänge. 
Darüber hinaus kann der Eingangsreferenzpegel 
auf +4 dBu oder –10 dBV gestellt werden. Weitere 
Informationen zum Kalibrieren von HD I/O finden 
Sie im HD I/O-Handbuch.

Bei folgenden Audio-Interfaces sind keine Trimm-
Potentiometer vorhanden: HD OMNI, HD MADI. 
Bei einigen Pro Tools-Audio-Interfaces, die nicht 
über eine Trimm-Funktion für die Ausgänge 
verfügen (etwa HD OMNI), kann der Eingangspegel 
über die Software eingestellt werden (Setup > 
Hardware). Weitere Informationen finden Sie im 
Handbuch zum Audio-Interface.

Anschließen einer Audioquelle
Je nach Pro Tools-Audio-Interface können Sie 
verschiedene Arten von Audioquellen (wie etwa 
Musikinstrumente, Mikrofone und 
Mischpultausgänge) anschließen. Siehe 
Benutzerhandbuch zum Pro Tools-System. 
Zusätzliche Informationen finden Sie in der im 
Lieferumfang der Audioquelle enthaltenen 
Dokumentation.

Wenn Sie eine Audioquelle an einen Pro Tools-
Eingang anschließen, der vorher nicht für Eingänge 
konfiguriert war, müssen Sie möglicherweise die 
Hardware im Hardware Setup-Dialogfeld neu 
konfigurieren. (Informationen hierzu finden Sie im 
Benutzerhandbuch.) Außerdem müssen Sie 
möglicherweise die I/O-Signalpfade im I/O Setup-
Dialogfeld neu festlegen (siehe Kapitel 7: „I/O-
Setup“.).

Aufnehmen mit dem 
Metronom
Wenn Sie beabsichtigen, in Ihrer Session MIDI- 
oder Instrumentenspuren zu verwenden, oder 
wenn das Audiomaterial, mit dem Sie arbeiten, in 
Takten und Schlägen gemessen wird, sollten Sie 
bei der Aufnahme einen Metronom-Klick als 
Taktreferenz verwenden. Dadurch wird 
sichergestellt, dass aufgenommenes MIDI- und 
Audiomaterial dem Takt- und Schlagschema der 
Session entspricht.

Wenn das Material in Ihren Spuren auf die Schläge 
abgestimmt ist, können Sie einige überaus 
nützliche Editierfunktionen von Pro Tools nutzen. 
Sie können etwa Events und Clips (MIDI und 
Audio) sowie einzelne MIDI-Noten quantisieren 
und einzelne Takte und Songabschnitte im Grid-
Modus kopieren und einfügen.

Ohne Metronom aufgenommenes Material 
kann in Pro Tools mit Beat Detective (siehe 
Kapitel 30: „Beat Detective“) an Takt- und 
Schlagpositionen ausgerichtet werden. 
Alternativ dazu können Sie zum Bestimmen 
des Tempos auch den Identify Beat-Befehl 
verwenden (siehe „Identify Beat-Befehl“ auf 
Seite 818).
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Erstellen einer Click-Spur
In Pro Tools können Sie eine Metronomspur mithilfe 
des Click-Plug-Ins erstellen. Außerdem können Sie 
für diesen Zweck das TL Metro-Plug-In (das im 
Lieferumfang von Pro Tools enthalten ist) oder ein 
MIDI-Instrument verwenden.

So erstellen Sie eine Metronomspur mit dem Click-
Plug-In:

 Wählen Sie Track > Create Click Track.

Pro Tools erstellt eine neue Auxiliary-Eingangs-
Spur namens „Click“, auf der das Click-Plug-In 
bereits eingeschleift ist. Im Edit-Fenster ist die 
Spurhöhe der Click-Spur bereits auf „Mini“ 
festgelegt. Sie können mehr als eine Click-Spur 
erstellen. Alle nachfolgenden Click-Spuren 
werden nacheinander entsprechend benannt, etwa 
„Click 1“, „Click 2“ und „Click 3“.

Um beim Abspielen und während der Aufnahme 
das Metronom zu hören, konfigurieren Sie die 
„Click Options“ (siehe „Click-Optionen“ auf 
Seite 432) und stellen Sie sicher, dass „Click“ 
aktiviert ist (siehe „Aktivieren der 
Metronomfunktion“ auf Seite 431).

So erstellen Sie eine Click-Spur mithilfe von MIDI:

1 Erstellen Sie eine neue Auxiliary-Eingangs- 
oder Instrumentenspur (mono).

2 Sie haben folgende Möglichkeiten:

• Wählen Sie im Input-Selektor der Spur den Pfad 
aus, an den das MIDI-Gerät angeschlossen 
werden soll.

• Fügen Sie ein Instrumenten-Plug-In auf der Spur 
ein (etwa TL Metro oder Xpand2).

3 Konfigurieren Sie die Click/Countoff-Optionen. 
Stellen Sie außerdem sicher, dass im Output-
Popup-Menü der Anschluss für das MIDI-Gerät 
oder das Instrumenten-Plug-In ausgewählt ist 
(siehe „Click-Optionen“ auf Seite 432).

4 Aktivieren Sie Click (siehe „Aktivieren der 
Metronomfunktion“ auf Seite 431).

Aktivieren der 
Metronomfunktion
Click-Spuren müssen aktiviert werden, damit sie 
beim Abspielen oder während der Aufnahme 
gehört werden.

So aktivieren Sie die Metronomfunktion im MIDI-
Menü:

 Wählen Sie Options > Click.

So aktivieren Sie die Metronomfunktion im 
Transport-Fenster:

1 Sie haben folgende Möglichkeiten, die MIDI-
Steuerelemente im Transport-Fenster 
anzuzeigen:

• Wählen Sie View > Transport > MIDI Controls.

• Wählen Sie im Menü des Transport-Fensters die 
Option MIDI Controls.

• Klicken Sie im Transport-Fenster bei gedrückter 
Strg-Taste (Windows) oder Befehlstaste (Mac) 
auf die Schaltfläche „+“, um die MIDI-
Steuerelemente anzuzeigen.

Informationen zu den Plug-Ins Click und 
TL Metro finden Sie im Audio-Plug-Ins-
Handbuch.

Auswählen der MIDI-Steuerelemente über das 
Transport-Fenstermenü
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• Klicken Sie im Transport-Fenster bei gedrückter 
Alt-Taste (Windows) oder Wahltaste (Mac) auf 
die Schaltfläche „+“, um die MIDI-
Steuerelemente und die Zähler anzuzeigen.

2 Klicken Sie im Transport-Fenster auf die 
Metronom-Schaltfläche, um sie zu aktivieren.

3 Damit das Vorzählen des Metronoms beim 
Aufnehmen oder Abspielen zu hören ist, 
klicken Sie im Transport-Fenster auf die Count 
Off-Schaltfläche, um sie zu aktivieren.

Wenn Musiker das Vorzählen vor der Aufnahme 
hören, hilft ihnen das, zur richtigen Zeit und im 
richtigen Tempo zu spielen. Die Count Off-
Schaltfläche im Transport-Fenster zeigt die 
Anzahl der Takte an, die vor dem Start des 
Transports vorgezählt werden.

Click-Optionen
Pro Tools bietet Optionen und Steuerelemente 
zur Metronomsteuerung. Die folgenden Schritte 
dienen zur Konfigurierung und Aktivierung einer 
Metronomfunktion mit dem Click-Plug-In oder 
MIDI.

So konfigurieren Sie die Click-Optionen:

1 Öffnen Sie das Click/Countoff Options-
Dialogfeld, indem Sie einen der folgenden 
Schritte ausführen:

• Wählen Sie Setup > Click/Countoff.

• Doppelklicken Sie im Transport-Fenster auf die 
Metronom-Schaltfläche.

2 Im Click/Countoff Options-Dialogfeld haben 
Sie folgende Möglichkeiten:

• Wenn Sie das TL Metro- oder Click-Plug-In 
verwenden, wählen Sie im Output-Popup-Menü 
die None-Option.

• Wenn Sie ein MIDI-gesteuertes Metronom 
verwenden, wählen Sie im Output-Popup-Menü 
die Port-Nummer (Gerät) und den Kanal, über 
den der Metronomtakt abgespielt werden soll. 

Expand/Collapse-Schaltfläche „+“, Transport-Fenster 
mit MIDI-Steuerelementen

Metronom-Schaltfläche aktiviert

Count Off-Schaltfläche aktiviert

Das Vorzählen wird ignoriert, wenn 
Pro Tools online ist und mit dem SMPTE-
Timecode synchronisiert wird.

Click/Countoff Options-Dialogfeld
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3 Legen Sie den Ton, den Velocity-Wert und die 
Dauer für die betonten und unbetonten Noten 
fest. 

In Ihren Pro Tools-Sessions hören Sie die betonte 
Note auf dem ersten Schlag jedes Takts, die 
unbetonte auf den übrigen Schlägen.

4 Bestimmen Sie, wann der Metronom-Klick 
hörbar sein soll, indem Sie During play and 

record, Only during record oder Only during 

countoff auswählen.

5 Wenn Sie einen Countoff benutzen, geben Sie 
die Anzahl an Takten (Bars) an, die vorgezählt 
werden soll. Um den Countoff nur bei der 
Aufnahme zu hören, wählen Sie die 
entsprechende Option.

6 Klicken Sie auf OK.

Festlegen von Taktart 
und Tempo 
(Optional)

Festlegen der Taktart 
der Session
Beim Öffnen einer neuen Session in Pro Tools 
lautet die Standardtaktart 4/4. Wenn Sie mit 
Metronom mit einer anderen Taktart als 4/4 
aufnehmen möchten, stellen Sie die Taktart 
entsprechend ein.

Wenn die Taktart einer Session nicht zu der Musik 
passt, die Sie aufnehmen, stimmen die betonten 
Schläge nicht mit der gespielten Musik überein. Das 
führt dazu, dass auch das aufgenommene Material 
im Edit-Fenster nicht in das Taktschema passt.

Taktart-Events, die an beliebiger Stelle in einer 
Pro Tools-Session stattfinden können, werden in 
der Taktartleiste (Meter Ruler) angezeigt. Weitere 
Informationen zum Einfügen und Bearbeiten von 
Taktart-Events finden Sie unter „Taktart-Events“ 
auf Seite 822.

So legen Sie die Taktart für eine Session fest:

1 Doppelklicken Sie im Transport-Fenster auf die 
Meter-Schaltfläche.

2 Geben Sie die Taktart (Meter) für die Session 
ein und stellen Sie Location auf „1|1|000“ 
(um das Standard-Event durch das eingefügte 
Taktart-Event zu ersetzen).

3 Wählen Sie im Click-Popup-Menü einen 
Notenwert für den Takt. (Bei 6/8 wählen Sie 
beispielsweise eine punktierte Viertelnote.)

4 Klicken Sie auf OK, um das neue Taktart-Event 
einzufügen.

Wenn ein MIDI-Controller-Keyboard 
angeschlossen ist, können Sie neue 
Notenwerte auch auf diesem Weg einspielen.

Taktart (Schaltfläche)

Meter Change-Fenster
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Festlegen des Tempos der 
Session
Beim Öffnen einer neuen Session in Pro Tools 
beträgt das Standardtempo 120 BPM (Beats per 
Minute). Wenn Sie mit Metronom mit einem 
anderen Tempo als 120 BPM aufnehmen möchten, 
stellen Sie das Tempo entsprechend ein.

So ändern Sie das Tempo einer Session:

1 Doppelklicken Sie im Edit-Fenster auf den 
Song Start-Marker (siehe „Songstart-Marker“ 
auf Seite 798).

2 Geben Sie den BPM-Wert für die Session ein. 

3 Stellen Sie Location auf „1|1|000“ (um das 
Standard-Event durch das eingefügte Tempo-
Event zu ersetzen).

4 Wählen Sie im Resolution-Popup-Menü einen 
Notenwert für den Takt aus. (Bei 6/8 wählen Sie 
beispielsweise eine punktierte Viertelnote.)

5 Klicken Sie auf OK.

Verwenden des Manual Tempo-
Modus
Im Manual Tempo-Modus ignoriert Pro Tools 
die Tempo-Events in der Tempoleiste und gibt 
stattdessen ein manuelles Tempo wieder. Das 
manuelle Tempo kann entweder mit dem Tempo-
Schieberegler eingestellt oder, wenn Sie es nicht 
genau kennen, durch Klopfen eingegeben werden.

Beachten Sie, dass es zwar möglich ist, das 
manuelle Tempo während der Wiedergabe 
anzupassen, diese dadurch jedoch kurz 
unterbrochen wird.

So stellen Sie das manuelle Tempo mit dem 
Tempo-Schieberegler ein:

1 Um die MIDI-Steuerelemente im Transport-
Fenster anzuzeigen, wählen Sie View > 

Transport > MIDI Controls.

2 Klicken Sie im Transport-Fenster auf die 
Conductor-Schaltfläche, um diese zu 
deaktivieren. Pro Tools schaltet in den Manual 
Tempo-Modus um. In diesem Modus werden 
sämtliche Tempo-Events in der Tempo-Leiste 
ignoriert.

Tempo-Events, die an beliebiger Stelle in 
einer Pro Tools-Session stattfinden können, 
werden in der Tempo-Leiste angezeigt. 
Weitere Informationen zum Einfügen und 
Bearbeiten von Tempo Events finden Sie 
unter „Tempo“ auf Seite 799.

Sie können ein bestimmtes Tempo eingeben 
oder mit der T-Taste das Tempo „klopfen“.

Tempo Change-Fenster

Manual Tempo-Modus

Tempowert in BPM

Tempo Ruler Enable 
(Schaltfläche)

Tempo Resolution-Selektor
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3 Wenn der BPM-Wert für einen anderen 
Notenwert als die vorgegebene Viertelnote 
gelten soll, klicken Sie auf den Tempo 
Resolution-Selektor und wählen Sie einen 
anderen Notenwert. (Bei 6/8 wählen Sie 
beispielsweise eine punktierte Viertelnote.)

4 So geben Sie ein neues Tempo ein:

• Ziehen Sie den Tempowert nach oben oder nach 
unten. Um detailliertere Anpassungen 
vorzunehmen, halten Sie während des Ziehens 
die Strg-Taste (Windows) bzw. die Befehlstaste 
(Mac) gedrückt.

• Klicken Sie auf den Tempowert, geben Sie eine 
neue Zahl ein und drücken Sie die Eingabetaste.

So verlassen Sie den Manual Tempo-Modus und 
aktivieren die Tempoleiste:

 Klicken Sie im Transport-Fenster auf die 
Conductor-Schaltfläche, um diese zu aktivieren.

So stellen Sie das manuelle Tempo durch 
Klopfen ein:

1 Stellen Sie sicher, dass die MIDI-
Steuerelemente im Transport-Fenster angezeigt 
werden (indem Sie View > Transport > MIDI 

Controls auswählen).

2 Klicken Sie im Transport-Fenster auf die 
Schaltfläche „Tempo Ruler Enable 
(Conductor)“, um diese zu deaktivieren. 
Pro Tools schaltet in den Manual Tempo-
Modus um. In diesem Modus werden sämtliche 
Tempo-Events in der Tempo-Leiste ignoriert.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie in das Tempo-Feld, sodass es 
hervorgehoben wird, und tippen Sie die T-Taste 
Ihrer Computertastatur mehrmals in der 
gewünschten Geschwindigkeit an.

• Wenn in den MIDI-Voreinstellungen die Option 
Use MIDI to Tap Tempo aktiviert ist, klicken Sie 
in das Tempo-Feld, sodass es aufleuchtet, und 
geben Sie ein Tempo ein, indem Sie auf der 
Tastatur Ihres MIDI-Controllers eine Note 
mehrmals im neuen Tempo spielen.

Zum Berechnen des neuen Tempos ermittelt 
Pro Tools die durchschnittliche Geschwindigkeit, 
mit der die letzten acht (oder weniger) Noten 
eingespielt wurden. Der berechnete BPM-Wert wird 
im Tempo-Feld des Transport-Fensters angezeigt.

So übernehmen Sie das neue Tempo:

 Deaktivieren Sie den Manual Tempo-Modus 
von Pro Tools, indem Sie auf die Schaltfläche 
„Tempo Ruler Enable (Conductor)“ klicken, 
und setzen Sie anschließend das Standardtempo 
für den Song Start-Marker auf das neue Tempo.
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Aufnahmemodi
Zur Aufnahme von Audiomaterial stehen in 
Pro Tools folgende Aufnahmemodi zur Verfügung:

• Normal (Nondestructive)

• Destruktiv

• Loop

• Der QuickPunch

• TrackPunch (nur Pro Tools HD)

• DestructivePunch (nur Pro Tools HD)

Sie haben folgende Möglichkeiten, den 
Aufnahmemodus auszuwählen:

 Wählen Sie den Aufnahmemodus im Options-
Menü aus. Wenn kein Aufnahmemodus 
ausgewählt ist, befindet sich Pro Tools im 
Aufnahmemodus „Normal (Nondestructive)“.

 Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Record-Schaltfläche 
und wählen Sie im Popup-Menü den 
Aufnahmemodus aus.

Die Darstellung der Record-Schaltfläche ändert 
sich und zeigt so den aktivierten Modus 
folgendermaßen an: 

• Leer für „Normal (Nondestructive)“ 

• „D“ für „Destructive“

• Schleifensymbol für „Loop“

• „P“ für QuickPunch

• „T“ für „TrackPunch“ (nur Pro Tools HD)

• „DP“ für „DestructivePunch“ (nur Pro Tools 
HD)

Aufnahmemodus „Normal 
(Nondestructive)“
Im Aufnahmemodus „Normal (Nondestructive)“ 
nimmt Pro Tools Audiomaterial nicht destruktiv 
auf, d. h., das Audiomaterial wird nicht von 
der Festplatte gelöscht, wenn Sie über die 
bestehenden Clips einer Spur aufnehmen. Sowohl 
neue als auch alte Audiodateien verbleiben 
auf Ihrer Festplatte und stehen als Clips in der 
Clips-Liste zur Verfügung.

Im Aufnahmemodus „Normal“ kann der 
Aufnahmebereich definiert werden, indem ein 
Bereich in einer Leiste oder in der Playlist einer 
Spur selektiert wird oder im Transport-Fenster die 
Start- und Endpunkte bestimmt werden. Wurde 
keine Selektion vorgenommen, beginnt die 
Aufnahme an der aktuellen Cursor-Position und 
läuft so lange, bis Sie im Transport-Fenster auf die 
Stop-Schaltfläche klicken.

Sie können auch zwischen den 
Aufnahmemodi von Pro Tools wechseln, 
wenn die Wiedergabe/Aufnahme gestoppt ist, 
indem Sie bei gedrückter Windows- 
(Windows) bzw. Ctrl-Taste (Mac) auf die 
Record-Schaltfläche klicken.

Aufnahmemodus „Destructive“ aktiviert

Bei der Aufnahme können Sie Speicherplatz 
sparen, indem Sie nicht mehr benötigte Takes 
entfernen (siehe „Löschen unerwünschter 
Clips“ auf Seite 279) und Audiodateien 
komprimieren (siehe „Komprimieren einer 
Audiodatei“ auf Seite 621).

Um einen Aufnahmebereich durch 
Auswählen in der Playlist einer Spur 
festlegen zu können, müssen Edit- und 
Timeline-Selektion gekoppelt sein. Siehe 
„Koppeln und Entkoppeln von Timeline- und 
Edit-Selektionen“ auf Seite 575.
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Die Pre- und Post-Roll-Einstellungen ermöglichen 
es, Material bis zum Start- und nach dem Endpunkt 
abzuhören, was besonders bei der Punch-
Aufnahme sehr nützlich ist (siehe „Punch-
Aufnahme von Audiomaterial über einen 
festgelegten Bereich“ auf Seite 465).

Aufnahmemodus „Destructive“
Im Aufnahmemodus „Destructive“ wird beim 
Aufnehmen über bestehende Clips das 
ursprüngliche Audiomaterial permanent ersetzt, 
wodurch Sie Festplattenspeicher sparen können. 
Wenn Sie jedoch über ausreichend 
Speicherkapazität verfügen, ist es in der Regel 
eher zu empfehlen, Pro Tools im Aufnahmemodus 
„Nondestructive“ auszuführen, um den Verlust 
von zuvor aufgenommenem Material zu 
verhindern.

Das Definieren des Aufnahmebereichs und das 
Festlegen von Pre- und Post-Roll-Zeiten 
funktioniert im Modus „Destructive“ genauso wie 
im Modus „Normal (Nondestructive)“.

Im Gegensatz zu den anderen Aufnahmemodi ist 
es beim Modus „Destructive“ nicht möglich, 
Takes während der Aufnahme abzubrechen oder 
rückgängig zu machen (siehe „Abbrechen eines 
Aufnahme-Takes“ auf Seite 458).

Aufnahmemodus „Loop“
Der Aufnahmemodus „Loop“ ermöglicht es Ihnen, 
Takes nacheinander (nicht destruktiv) 
aufzunehmen, während derselbe Abschnitt des 
Audiomaterials wiederholt wird. Dabei handelt es 
sich um eine bequeme Technik für die schnelle 
Aufnahme von mehreren Takes eines Parts, ohne 
dabei an Spontaneität einzubüßen.

Der geloopte und aufgenommene Zeitabschnitt, 
der mindestens eine Sekunde lang sein muss, wird 
gewählt, indem der gewünschte Bereich in einem 
Lineal oder in der Playlist einer Spur selektiert 
wird oder indem im Transport-Fenster Start- und 
Endpunkte bestimmt werden. Die Pre-Roll-
Einstellung kommt, falls aktiviert, während des 
ersten Aufnahmedurchgangs zur Anwendung. Bei 
jedem folgenden Loop werden die Pre- und Post-
Roll-Zeiten jedoch ignoriert.

Beim Verwenden des Loop-Aufnahmemodus wird 
jeder folgende Take in der Clipliste als fortlaufend 
nummerierter Clip angezeigt. Die verschiedenen 
Takes, deren Längen und Startzeiten identisch 
sind, können über das Matches-Popup-Menü 
problemlos abgehört und an der richtigen Stelle 
der Spur platziert werden (siehe „Selektieren 
alternativer Takes“ auf Seite 472).

Im Aufnahmemodus „Destructive“ wird die 
Wellenformübersicht erst neu gezeichnet, 
wenn Sie die Aufnahme anhalten.

Der Aufnahmemodus „Destructive“ wird bei 
mit AudioSuite gerenderten Clips mit Handles 
nicht unterstützt. Sie können solche Clips 
konsolidieren, wenn Sie den Aufnahmemodus 
„Destructive“ verwenden müssen.

Damit Sie einen Aufnahmebereich durch 
Auswählen in der Playlist einer Spur 
festlegen können, muss die Option „Link 
Timeline and Edit Selection“ aktiviert sein. 
Siehe „Koppeln und Entkoppeln 
von Timeline- und Edit-Selektionen“ auf 
Seite 575.

Im Loop-Aufnahmemodus wird die 
Wellenformübersicht erst neu gezeichnet, 
wenn Sie die Aufnahme anhalten.
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Der QuickPunch
Im QuickPunch-Modus können Sie während der 
Wiedergabe über einen manuellen Befehl sofort in 
die Aufnahme auf scharfgeschalteten Spuren 
einsteigen (Punch-In) und wieder aussteigen 
(Punch-Out), indem Sie im Transport-Fenster auf 
die Record-Schaltfläche klicken. Die Aufnahme 
mit QuickPunch ist nicht destruktiv.

Bei Verwendung von QuickPunch beginnt 
Pro Tools beim Start der Wiedergabe mit der 
Aufnahme einer neuen Datei. Dabei werden an 
jedem Punch-In/Punch-Out-Punkt automatisch 
Clips erstellt. Diese Clips werden in der Playlist der 
Spur angezeigt, während die gesamte Audiodatei 
zusammen mit den mit QuickPunch erstellten Clips 
in der Clipliste erscheint. In einem einzigen 
Durchgang können bis zu 200 dieser „Running 
Punches“ durchgeführt werden.

Obwohl Sie auch in den anderen Modi Punch-
Aufnahmen durchführen können (indem Sie den 
Aufnahmebereich manuell bestimmen), ist ein 
augenblickliches Zurückschalten zur 
Abhörfunktion beim Punch-Out nur mit 
QuickPunch möglich.

TrackPunch 
(Nur Pro Tools HD)

TrackPunch ermöglicht Punch-In, Punch-Out oder 
das Aufheben der Scharfschaltung einzelner 
Spuren ohne Unterbrechung der Online-Aufnahme 
und -Wiedergabe. 

TrackPunch ist ein nicht destruktiver 
Aufnahmemodus. Wenn der TrackPunch-Modus 
für eine Spur aktiviert ist, beginnt Pro Tools bei 
Start der Wiedergabe mit der Aufnahme einer neuen 
Datei. Während der Wiedergabe können Sie die 
Scharfschaltung für die Aufnahme für eine 
beliebige Kombination von Spuren oder auf allen 
Spuren aktivieren bzw. deaktivieren oder Punch-In- 
und Punch-Out-Vorgänge ausführen. 

TrackPunch erstellt automatisch an jedem Punch-
In- und Punch-Out-Punkt in dieser Datei Clips. 
Diese Clips werden in der Playlist der Spur 
angezeigt, während die gesamte Audiodatei 
zusammen mit den mit TrackPunch erstellten 
Clips in der Clipliste erscheint. In einem einzigen 
Durchgang können bis zu 200 dieser „Running 
Punches“ durchgeführt werden. 

DestructivePunch
(Nur Pro Tools HD)

DestructivePunch ist ein destruktiver 
Aufnahmemodus, mit dem Sie während der 
Wiedergabe auf einzelnen Audiospuren sofort in 
die Aufnahme einsteigen (Punch-In) und wieder 
aussteigen (Punch-Out), während eine 
fortlaufende Audiodatei auf jeder Punch-
aktivierten Spur beibehalten wird. 

Weitere Informationen zu QuickPunch finden 
Sie unter „QuickPunch-Audioaufnahme“ auf 
Seite 505.

Weitere Informationen zu TrackPunch finden 
Sie unter „TrackPunch-Audioaufnahme“ auf 
Seite 507.

Weitere Informationen zu DestructivePunch 
finden Sie unter „DestructivePunch-
Audioaufnahme“ auf Seite 512.
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Aufnahmemodi und MIDI
Zusätzlich zu den verschiedenen Aufnahmemodi 
gibt es im Transport-Fenster eine MIDI Merge-
Schaltfläche, mit der bestimmt werden kann, 
wie MIDI aufgenommen wird. Ist diese 
Schaltfläche aktiviert (Merge-Modus), werden die 
neuen Daten bei der Aufnahme über bestehende 
MIDI-Clips mit den alten Daten vereint. Wenn die 
MIDI Merge-Schaltfläche deaktiviert ist (Replace-
Modus), wird das alte Material durch das neue 
ersetzt.

Die Aufnahme von MIDI erfolgt bei beiden 
Aufnahmemodi („Nondestructive“ und 
„Destructive“) auf dieselbe Weise. Darüber hinaus 
ist die Aktivierung von QuickPunch oder 
TrackPunch nicht nötig, wenn Sie für MIDI einen 
„On the Fly“-Punch durchführen möchten. Diese 
Funktion ist sowohl im Nondestructive- als auch 
im Destructive-Modus verfügbar.

Im Gegensatz zur Loop-Aufnahme von 
Audiomaterial bestimmt hier der Status der MIDI 
Merge-Schaltfläche, ob bestehendes Material 
ersetzt oder zusammen mit dem neuen Material 
gespeichert wird.

Außer bei aktivierter MIDI Merge-Schaltfläche ist 
die MIDI-Aufnahme immer destruktiv, wobei das 
Material in dem Clip entweder überschrieben oder 
weiteres Material hinzugefügt wird. (Es ist jedoch 
möglich, einen MIDI-Aufnahmedurchgang 
rückgängig zu machen.) Dabei gibt es eine 
Ausnahme: Wenn der Loop-Aufnahmemodus 
aktiviert ist, werden bei der Aufnahme von neuem 
Material bestehende Clips auf einer Spur ersetzt. 
Die alten Clips bleiben intakt und sind weiterhin in 
der Clipliste und im Matches-Popup-Menü 
verfügbar. Im Loop-Aufnahmemodus ist der MIDI 
Merge-Modus nicht wirksam und die betreffende 
Schaltfläche abgeblendet.

Konfigurieren von 
Standardnamen für 
Audiodateien und -Clips 
(Optional)

Bei der Aufnahme auf Spuren werden neue 
Dateien und Clips nach den Spuren benannt (siehe 
„Benennen von Spuren“ auf Seite 222).

Bei der Aufnahme auf eine Audiospur werden die 
resultierenden Datei- und Clipnamen nach der 
Spur benannt. So wird nach der erstmaligen 
Aufnahme auf einer Spur namens „Electric Gtr“ 
eine Audiodatei mit dem Namen „Electric Gtr_01“ 
erstellt. Darüber hinaus wird der Clipliste ein Clip 
mit dem Namen „Electric Gtr_01“ hinzugefügt. 
Dieser Clip enthält eine Whole-File-Datei.

Aufeinanderfolgende Takes auf der gleichen Spur 
werden gleich benannt, jedoch (zur Angabe 
der Take-Nummer) fortlaufend nummeriert 
(etwa „Electric Gtr_02“). Durch einen zweiten 
Zahlensatz (wie in „Electric Gtr_01-01“) wird ein 
aus einer Editierung automatisch erzeugter Clip 
bezeichnet. 

MIDI Merge-Schaltfläche aktiviert
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Beim Aufnehmen von MIDI-Spuren wird ein 
ähnliches Benennungsschema benutzt, das jedoch 
auf nur einen Zahlensatz beschränkt ist. Wenn etwa 
auf einer Spur namens „Synth 1“ aufgenommen 
wurde, wird ein Clip mit der Bezeichnung „Synth 1-
01“ erstellt. Nachfolgende, entweder aus 
zusätzlichen Takes oder aus Clip-Editierungen 
erstellte Clips für diese Spur werden fortlaufend 
nummeriert (etwa „Synth 1-02“).

So benennen Sie eine Spur um:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie im Mix- oder Edit-Fenster 
auf die Schaltfläche mit dem betreffenden 
Spurnamen.

• Klicken Sie in der Tracks-Liste im Mix-, Edit-, 
MIDI Editor- oder Score Editor-Fenster mit der 
rechten Maustaste auf den Namen der Spur, die 
Sie umbenennen möchten.

2 Geben Sie im Track Name/Comments-
Dialogfeld einen neuen Namen für die Spur ein.

3 Klicken Sie auf OK.

Namen für Stereo-Audiospuren
Wenn auf Stereo-Audiospuren aufgenommen 
wird, werden den Namen der Audiodateien und -
Clips für den linken und den rechten Kanal die 
Suffixe „.L“ und „.R“ hinzugefügt.

Namen für Mehrkanalspuren 
(Nur Pro Tools HD)

Bei der Aufnahme auf Mehrkanal-Surround-
Spuren werden den Namen der Audiodateien und -
Clips für jeden Kanal folgende Suffixe 
hinzugefügt:

Die Modi „QuickPunch“, „TrackPunch“ 
und „Destructive Punch“ verwenden eine 
andere Methode zur Nummerierung von 
Clips. Weitere Hinweise finden Sie unter 
„TrackPunch-Audioaufnahme“ auf 
Seite 507.

Mehrkanalformat Datei- und Clip-Suffixe

LCR L, C, R

Quad L, R, Ls, Rs

LCRS L, C, R, S

5.0 L, C, R, Ls, Rs

5.1 L, C, R, Ls, Rs, LFE

6.0 L, C, R, Ls, Cs, Rs, LFE

6.1 L, C, R, Ls, Cs, Rs

7.0 L, C, R, Lss, Rss, Lsr, Rsr

7.1 L, C, R, Lss, Rss, Lsr, Rsr, 
LFE

7.0 SDDS L, Lc, C, R, Rc, Ls, Rs

7.1 SDDS L, Lc, C, R, Rc, Ls, Rs, LFE
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Zuweisen von Hardware-I/O 
auf einer Spur
Vor der Aufnahme auf einer Spur müssen Sie den 
Eingangs- und den Ausgangssignalpfad für das 
Material angeben, das Sie aufnehmen. Hierzu 
können Sie einen Hardware-Eingang 
(Aufnahmequelle) und einen Ausgangsbus (zum 
Abhören der Aufnahme) auf der Spur zuweisen.

So weisen Sie Hardware-I/O auf einer Spur zu:

1 Sie haben folgende Möglichkeiten, einen 
Hardware-Eingang (Aufnahmequelle) 
zuzuweisen:

• Wählen Sie im Mix-Fenster über den Input Path-
Selektor der Spur den entsprechenden 
Hardware-Eingang für Ihre Quelle.

• Wählen Sie bei aktiviertem I/O-Bedienfeld im 
Edit-Fenster über den Input Path-Selektor der 
Spur den entsprechenden Hardware-Eingang für 
Ihre Quelle.

2 Sie haben folgende Möglichkeiten, einen 
Ausgangsbus (zum Abhören der Aufnahme) 
zuzuweisen:

• Wählen Sie im Mix-Fenster über den Output 
Path-Selektor der Spur den entsprechenden 
Ausgangsbus für das Monitoring (etwa 
„Monitor“ oder „A 1–2“).

Input Path-Selektor, Mix-Fenster

Input Path-Selektor des Edit-Fensters

Output Path-Selektor, Mix-Fenster
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• Wählen Sie bei aktiviertem I/O-Bedienfeld im 
Edit-Fenster über den Output Path-Selektor der 
Spur den entsprechenden Ausgangsbus für das 
Monitoring (etwa „A 1–2“).

Scharfschalten von Spuren
Um Audio- oder MIDI-Material auf einer Spur 
aufnehmen zu können, müssen Sie diese 
zuerst mithilfe der Record Enable-Schaltfläche 
scharfschalten. Um gleichzeitig auf mehrere 
Spuren aufzunehmen, können Sie mehrere Audio-, 
Instrumenten- oder MIDI-Spuren scharfschalten. 

Wenn eine oder mehrere Spuren scharfgeschaltet 
sind, klicken Sie im Transport-Fenster auf 
die Record-Schaltfläche, um die Aufnahme 
scharfzuschalten. Klicken Sie anschließend im 
Transport-Fenster auf die Play-Schaltfläche, um 
die Aufnahme zu starten.

So schalten Sie eine Audio-, MIDI- oder 
Instrumentenspur scharf:

 Klicken Sie entweder im Mix-Fenster oder im 
Edit-Fenster auf die Record Enable-
Schaltfläche der Spur. Die Record Enable-
Schaltfläche der Spur blinkt rot, der Fader der 
Spur ist konstant rot und die Track Record 
Enabled-Anzeige im Transport-Fenster wird rot 
(dies zeigt an, dass mindestens eine Spur 
scharfgeschaltet ist).

Output Path-Selektor, Edit-Fenster

MIDI- und Instrumentenspuren können 
während der Aufnahme und Wiedergabe 
scharfgeschaltet werden. Zum Scharfschalten 
von Audiospuren muss der Transport 
angehalten oder QuickPunch, TrackPunch 
bzw. QuickPunch aktiviert werden. Weitere 
Informationen zu QuickPunch, TrackPunch 
und DestructivePunch finden Sie unter 
„Aufnahmemodi“ auf Seite 436.

Für die Aufnahme scharfgeschaltete Audiospur (Mix- 
und Edit-Fenster)

Drücken Sie Umschalt + R, um eine Spur 
scharfzuschalten, auf der sich der Edit-
Cursor oder eine Edit-Selektion befindet.

Edit-Fenster

Mix-Fenster
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So schalten Sie gleichzeitig mehrere Audiospuren 
scharf:

 Klicken Sie entweder im Mix-Fenster oder im 
Edit-Fenster auf die Record Enable-
Schaltfläche jeder Spur.

So schalten Sie gleichzeitig mehrere MIDI- und 
Instrumentenspuren scharf:

 Klicken Sie entweder im Mix-Fenster oder im 
Edit-Fenster bei gedrückter Umschalttaste auf 
die Record Enable-Schaltfläche jeder MIDI- 
bzw. Instrumentenspur.

So schalten Sie MIDI- und Instrumentenspuren 
mithilfe der Pfeiltasten scharf:

 Drücken Sie bei gedrückter Befehlstaste (Mac) 
oder Strg-Taste (Windows) den Nach-oben- 
bzw. den Nach-unten-Pfeil, um die vorherige 
bzw. nächste MIDI- oder Instrumentenspur 
scharfzuschalten. Die Scharfschaltung der 
vorherigen (bzw. nächsten) Spur wird 
aufgehoben.

So schalten Sie alle Audiospuren oder alle MIDI- 
und Instrumentenspuren scharf:

 Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die Record 
Enable-Schaltfläche einer beliebigen Audio-, 
Instrumenten- oder MIDI-Spur, um sie zu 
aktivieren bzw. zu deaktivieren. 

Beim Scharfschalten behandelt Pro Tools MIDI- 
und Instrumentenspuren als denselben Typ. Wenn 
Sie daher bei gedrückter Wahltaste (Mac) oder 
Alt-Taste (Windows) auf die Record Enable-
Schaltfläche einer beliebigen MIDI- oder 
Instrumentenspur klicken, werden alle MIDI- und 
Instrumentenspuren in der Session 
scharfgeschaltet.

So schalten Sie alle ausgewählten Audiospuren 
oder alle ausgewählten MIDI- oder 
Instrumentenspuren scharf:

 Klicken Sie bei gedrückter Wahl- und 
Umschalttaste (Mac) oder Alt- und 
Umschalttaste (Windows) auf die Record 
Enable-Schaltfläche einer beliebigen 
ausgewählten Audio-, MIDI- oder 
Instrumentenspur, um die Scharfschaltung für 
alle ausgewählten Spuren zu aktivieren bzw. zu 
deaktivieren.

Wenn der Latch-Aufnahmemodus nicht aktiviert 
ist, klicken Sie bei gedrückter Umschalttaste auf 
die Record Enable-Schaltfläche jeder Spur, um 
die Scharfschaltung für jede Spur einzuschalten. 
Siehe „Voreinstellung „Latch Record Enable 
Buttons““ auf Seite 444.

Wenn Sie möchten, dass die vorherige Spur 
während des Scharfschaltens neuer Spuren 
scharfgeschaltet bleibt, drücken Sie bei 
gedrückter Befehls- und Umschalttaste 
(Mac) oder Strg- und Umschalttaste 
(Windows) den Pfeil nach oben bzw. unten.

Durch Scharfschalten einer Spur, die zu einer 
Mix-Gruppe gehört, werden die anderen Spuren 
in der Gruppe nicht scharfgeschaltet. Um alle 
Spuren in einer Gruppe scharfzuschalten, klicken 
Sie in der Groups-Liste direkt links neben den 
Namen der Gruppe, um alle Spuren in der 
Gruppe auszuwählen. Klicken Sie dann bei 
gedrückter Wahl- und Umschalttaste (Mac) oder 
Alt- und Umschalttaste (Windows) auf die 
Record Enable-Schaltfläche einer der Spuren, 
um die ausgewählten Spuren scharfzuschalten.
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Voreinstellung „Latch Record 
Enable Buttons“
Wenn in den „Operation Preferences“ die Option 
Latch Record Enable Buttons ausgewählt ist, 
können Sie zusätzliche Audiospuren 
scharfschalten, indem Sie auf die jeweiligen 
Record Enable-Schaltflächen klicken. Vorher 
scharfgeschaltete Spuren bleiben scharfgeschaltet. 
Die Option Latch Record Enable Buttons ist nur 
für Audiospuren verfügbar.

Wenn die Option Latch Record Enable Buttons 
nicht ausgewählt ist, wird durch Scharfschalten 
einer nachfolgenden Audiospur die vorher 
scharfgeschaltete Audiospur deaktiviert.

So aktivieren Sie die Voreinstellung „Latch Record 
Enable Buttons“:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Wählen Sie Latch Record Enable Buttons.

Record Safe-Modus
In Pro Tools steht für jede Spur ein Record Safe-
Modus zur Verfügung, der die versehentliche 
Scharfschaltung von Spuren verhindert. 
Verwenden Sie den Record Safe-Modus, um zu 
verhindern, dass wichtige Audio- oder MIDI-
Daten von einer Aufnahme überschrieben werden.

So versetzen Sie eine Audio-, MIDI- oder 
Instrumentenspur in den Record Safe-Modus:

 Klicken Sie bei gedrückter Befehlstaste (Mac) 
oder Strg-Taste (Windows) auf die Record 
Enable-Schaltfläche der Spur. Die Record 
Enable-Schaltfläche wird abgeblendet.

Wiederholen Sie den Vorgang, um den Record 
Safe-Modus für die Spur wieder zu deaktivieren.

So versetzen Sie alle Audio-, MIDI- oder 
Instrumentenspuren in den Record Safe-Modus:

 Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) oder Strg- und Alt-Taste 
(Windows) auf die Record Enable-Schaltfläche 
einer beliebigen Spur.

Wiederholen Sie den Vorgang, um den Record 
Safe-Modus für alle Spuren wieder zu 
deaktivieren.

So versetzen Sie alle derzeit ausgewählten Spuren 
in den Record Safe-Modus:

 Klicken Sie bei gedrückter Befehls-, Wahl- und 
Umschalttaste (Mac) oder Strg-, Alt- und 
Umschalttaste (Windows) auf die Record 
Enable-Schaltfläche einer beliebigen 
ausgewählten Spur, um den Record Safe-
Modus für die Spuren zu aktivieren bzw. 
zu deaktivieren.
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Arbeiten mit Festplatten für 
die Aufnahme

Überwachen des verfügbaren 
Speicherplatzes
In Pro Tools können Sie überprüfen, wie viel 
Speicherplatz verfügbar ist. Das Disk Usage-
Fenster zeigt den verfügbaren Speicherplatz für 
jedes an das System angeschlossene Laufwerk als 
Text- und als Balkenanzeige an.

So überwachen Sie den verfügbaren Speicherplatz 
auf dem Laufwerk während einer Pro Tools-Session:

 Wählen Sie Window > Disk Space.

So zeigen Sie den verfügbaren Speicherplatz in 
einer reinen Textansicht an:

 Wählen Sie im Disk Usage-Menü die Option 
Text Only.

Aufnehmen mit mehreren 
Festplatten
(Optional)

Pro Tools platziert aufgenommene Audiodateien 
standardmäßig im Audio Files-Ordner, einem 
Unterordner des Session-Ordners. Wenn Sie über 
mehrere Festplatten für die Aufnahme verfügen, 
können Sie das Disk Allocation-Fenster 
verwenden, um für einzelne Spuren 
unterschiedliche Festplattenverzeichnisse für die 
Aufnahme von Audiodateien festzulegen.

Festplatten, deren Speicherplatz vollständig belegt ist, 
werden im Disk Allocation-Fenster nicht angezeigt.

Um die Systemleistung zu optimieren, kann 
Pro Tools jede Spur von einer anderen Festplatte 
aus aufnehmen und wiedergeben. Darüber hinaus 
können Sie mit der Option „Round Robin 
Allocation“ jede neu erstellte Spur auf mehrere 
Audio-Laufwerke verteilen.

Navigieren im Disk Allocation-Fenster

So ändern Sie die Größe des Disk Allocation-
Fensters:

 Ziehen Sie die untere rechte Ecke des Fensters.

So scrollen Sie im Disk Allocation-Fenster nach 
oben oder nach unten:

 Drücken Sie die Bild-auf- oder Bild-ab-Taste.

Disk Usage-Fenster

Disk Usage-Fenster, Text Only-Ansicht ausgewählt
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Zuweisen von Audio-Laufwerken 
im System

So weisen Sie in Ihrem System Audio-
Laufwerke zu:

1 Wählen Sie Setup > Disk Allocation.

2 Weisen Sie im Disk Allocation-Fenster jeder 
Spur ein Laufwerk zu, indem Sie in die Spalte 
„Root Media Folder“ klicken und anschließend 
im Disk Allocation-Popup-Menü ein Volume 
auswählen.

Nur mit „R“ (Wiedergabe und Aufnahme) 
bezeichnete Festplatten können im Disk 
Allocation-Fenster ausgewählt werden. Weitere 
Informationen finden Sie unter „Performance- und 
Transfer-Volumes“ auf Seite 283.

Auf jedem Laufwerk wird ein Ordner mit dem 
Namen der Session erstellt, der Unterordner für 
Audio- und Fade-Dateien enthält.

• Um eine Spur einer anderen Festplatte 
zuzuweisen, klicken Sie auf die Spur und 
wählen Sie einen Laufwerksnamen.

• Um alle Spuren demselben Laufwerk 
zuzuweisen, halten Sie beim Auswählen des 
Laufwerksnamens die Wahltaste (Mac) bzw. 
die Alt-Taste (Windows) gedrückt.

• Zum Auswählen mehrerer untereinander 
stehender Spuren halten Sie die Umschalttaste 
gedrückt und klicken Sie in der Track-Spalte auf 
die Namen der ersten und der letzten Spur der 
gewünschten Auswahl.

• Zum Auswählen mehrerer Spuren, die nicht 
unmittelbar untereinander stehen, halten Sie die 
Befehlstaste (Mac) bzw. die Strg-Taste 
(Windows) gedrückt und klicken auf die 
gewünschten Spuren.

3 Um aufgenommene Audiodateien in einem 
bestehenden Ordner zu speichern (ohne dazu 
einen weiteren Session-Ordner zu erstellen), 
aktivieren Sie Customize Allocation Options, 
klicken Sie auf Change und wählen Sie 
anschließend den Ordner. Wenn Sie in diesem 
Ordner Unterordner erstellen möchten, 
aktivieren Sie die Option Create Subfolders for 

Audio, Video, and Fade Files.

4 Um neu erstellte Spuren automatisch auf die 
an das System angeschlossenen Laufwerke 
zu verteilen, wählen Sie die Option Use Round 

Robin Allocation for New Tracks.

Disk Allocation-Fenster

Disk Allocation-Popup-Menü
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Wenn Sie die Option „Round Robin Allocation“ 
verwenden und Audiodaten auf der Startfestplatte 
Ihres Systems speichern wollen, gehen Sie wie 
folgt vor:

• Öffnen Sie den Workspace-Browser (Window > 

Workspace) und setzen Sie die betreffende 
Volume-Kennzeichnung auf „R“ 
(Aufnahme/Wiedergabe). Siehe „Volume-
Zuweisung im Arbeitsbereich“ auf Seite 447.

5 Klicken Sie abschließend auf OK.

Speichern der Einstellungen für 
die Festplattenzuweisung
Um die Disk Allocation-Einstellungen bei 
zukünftigen Sessions wieder verwenden zu 
können, speichern Sie die Sessions als Vorlage. 
Weitere Hinweise finden Sie unter „Session-
Vorlagen“ auf Seite 169.

Festplattenzuweisung und 
plattformübergreifende 
Sessions
Um einen plattformübergreifenden Betrieb 
sicherzustellen, müssen Pro Tools-Sessions auf 
Mac und die dazugehörigen Audiodateien auf 
Mac-formatierten Festplattenlaufwerken 

(HFS oder HFS+) liegen. Analog dazu müssen 
Pro Tools-Sessions und die dazugehörigen 
Audiodateien unter Windows auf Windows-
formatierten NTFS-Laufwerken liegen. 

Neuzuweisen von Spuren
Wenn Sie eine Session öffnen, in der einige der 
vorher zugewiesenen Laufwerke nicht mehr 
verfügbar sind (oder nicht zur aktuellen Plattform 
der Session passen), führt Pro Tools eine 
automatische Neuzuweisung von Spuren an das 
Volume durch, auf dem die Session-Datei 
gespeichert ist. In diesem Fall können Sie die 
Spuren gegebenenfalls mithilfe des Disk 
Allocation-Dialogfelds anderen Laufwerken 
zuweisen.

Volume-Zuweisung im 
Arbeitsbereich
Die Volume-Zuweisung im Arbeitsbereich 
(Workspace) kann sich auf die Verfügbarkeit von 
Festplatten und daher auch auf die 
Festplattenzuweisung auswirken. Im Workspace-
Browser können Sie Volumes als „R“ 
(Aufnahme), „P“ (Wiedergabe) oder „T“ 
(Transfer) kennzeichnen. Beim Ändern der 
Kennzeichnung einer Festplatte zu 
schreibgeschützt („P“ oder „T“) müssen Sie das 
Disk Allocation-Fenster auf Spuren überprüfen, 
die zuvor diesem Laufwerk zugewiesen wurden. 
Weitere Informationen finden Sie unter „Volume-
Berechtigungen“ auf Seite 286.

Bei partitionierten Laufwerken wird die 
Option „Round Robin Allocation“ nicht 
unterstützt.

Wenn Sie einzelne gültige, angemeldete 
Volumes aus den Round Robin Allocation-
Durchgängen ausschließen möchten, öffnen 
Sie den Workspace-Browser und schützen Sie 
die betreffenden Volumes, indem Sie sie als 
„P“ (nur Wiedergabe) oder „T“ (Transfer) 
kennzeichnen. Weitere Informationen finden 
Sie unter „Volume-Berechtigungen“ auf 
Seite 286.

Siehe „Speichern von mit Windows kompatiblen 
Kopien von Mac-Sessions“ auf Seite 391 und 
„Austauschen von auf verschiedenen 
Plattformen erstellten Sessions“ auf Seite 389.

Eine Neuzuweisung von Spuren hat keine 
Auswirkungen auf das zuvor aufgenommene 
Audiomaterial. Es sind nur neu gespeicherte 
Audioaufnahmen davon betroffen.
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Aufnehmen auf das System-
Volume
Pro Tools lässt zwar die Aufnahme auf das 
System-Volume zu, von dieser Einstellung wird 
jedoch im Allgemeinen abgeraten. Bei einer 
Aufnahme und Wiedergabe von Audiomaterial auf 
Systemlaufwerken ist die Leistung geringer als bei 
externen Laufwerken.

Nehmen Sie nur auf Systemlaufwerken auf, wenn 
dies absolut notwendig ist, beispielsweise wenn das 
Computersystem nur über eine Festplatte verfügt 
oder die anderen Festplatten absolut voll sind.

Das System-Volume wird bei der Option „Round 
Robin Allocation“ (unabhängig von der Volume-
Kennzeichnung im Workspace-Browser) 
standardmäßig nicht berücksichtigt. Hinweise zum 
Einschließen des System-Volume in die Round 
Robin-Zuweisung finden Sie unter „Zuweisen von 
Audio-Laufwerken im System“ auf Seite 446.

Auswählen eines Record 
Input Monitoring-Modus
Pro Tools bietet während der Aufnahme zwei 
Monitoring-Modi: Auto Input und Input Only. 
Diese Monitoring-Modi bestimmen, wie 
Eingangssignale während der Wiedergabe, 
Aufzeichnung oder des angehaltenen Transports 
abgehört werden.

Auto Input-Monitoring
Im Auto Input-Modus hört Pro Tools 
Audioeingänge ab, wenn die Wiedergabe der 
Session angehalten ist. Wenn die Wiedergabe für 
ein Punch-In gestartet wird, hört Pro Tools 
bestehendes Spurmaterial bis zu der Stelle ab, an 
der das Punch-In erfolgte. Während des Punch-In 
wird das Eingangssignal abgehört. Beim Punch-
Out schaltet das Monitoring zum bestehenden 
Spurmaterial zurück. Das ähnelt der 
automatischen Umschaltlogik, wie sie auf 
digitalen und analogen Mehrspur-Bandmaschinen 
zu finden ist.

Wenn Sie ein Pro Tools-System mit mehreren 
Laufwerken haben und die gleichzeitige 
Aufnahme von mehreren Spuren planen, 
sollten Sie das Systemlaufwerk als nur für die 
Wiedergabe oder nur für den Transfer 
kennzeichnen.

Wenn Sie den Auto Input-Modus verwenden, 
erfolgt das Zurückschalten zum Abhören von 
Spurmaterial beim Punch-Out-Vorgang 
nicht augenblicklich.

In Pro Tools HD befinden sich Spuren 
standardmäßig im Auto Input-Modus und 
es steht für jede Spur ein Monitor-
Steuerelement (TrackInput-Schaltfläche) 
zur Verfügung. Siehe „Auswählen von 
Record Monitor-Modi mit TrackInput-
Monitoring“ auf Seite 449.



Kapitel 20: Aufnahme-Setup 449

Input Only-Monitoring
Im Input Only-Modus hört Pro Tools auf einer 
scharfgeschalteten Spur ausschließlich 
Audioeingänge ab. Dies erfolgt unabhängig von 
einer eventuellen Punch-In-/Out-Selektion.

In Pro Tools leuchtet die Statusanzeige „Input 
Monitor Enabled“ im Transport-Fenster grün, 
wenn der Input Only-Modus aktiviert ist.

Unter Pro Tools HD leuchtet die Anzeige grün, 
wenn „TrackInput“ für Spuren aktiviert ist (siehe 
„Auswählen von Record Monitor-Modi mit 
TrackInput-Monitoring“ auf Seite 449).

Auswählen eines Record 
Monitor-Modus

So legen Sie fest, dass scharfgeschaltete Spuren 
das Auto Input-Monitoring verwenden:

 Wählen Sie Track > Auto Input Monitoring.

So legen Sie fest, dass scharfgeschaltete Spuren 
das Input Only-Monitoring verwenden:

 Wählen Sie Track > Input Only Monitoring.

Auswählen von Record Monitor-
Modi mit TrackInput-Monitoring
(Nur Pro Tools HD)

Mit TrackInput-Monitoring können Sie für 
einzelne Audiospuren jederzeit zwischen den 
Monitoring-Modi „Auto Input“ und „Input Only“ 
umschalten, auch während Wiedergabe, 
Aufnahme, Stopp und sogar wenn eine Spur nicht 
scharfgeschaltet ist. Das TrackInput-Monitoring 
bietet die Flexibilität, die beim Overdubbing und 
Mixen benötigt wird, und entspricht in etwa der 
Eingangsumschaltung auf analogen 
Mehrspurrekordern und ähnlichen Geräten.

Ist die TrackInput-Schaltfläche in einer Spur 
aktiviert (grün), hört die Spur Audio im Input 
Only-Modus ab. 

Ist die TrackInput-Schaltfläche in einer Spur 
deaktiviert, hört die Spur im Auto Input-Modus ab.

Status „Input Monitor Enabled“, Transport-Fenster

Um zwischen Auto Input- und Input Only-
Monitoring umzuschalten, drücken Sie 
Wahl + K (Mac) bzw. Alt + K (Windows).

TrackInput-Monitoring aktiviert (Input Only), im Edit-
Fenster

TrackInput-Monitoring deaktiviert (Audio Input), 
im Edit-Fenster
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Sie haben folgende Möglichkeiten, den Monitor-
Modus für Audiospuren umzuschalten:

 Für die Umschaltung einzelner Spuren klicken 
Sie auf die TrackInput-Schaltfläche für jede 
Spur, für die Sie den Monitor-Modus 
umschalten möchten.

 Um den Monitor-Modus für alle Spuren in der 
Session umzuschalten, klicken Sie bei 
gedrückter Wahltaste (Mac) oder Alt-Taste 
(Windows) auf die TrackInput-Schaltfläche.

 Um den Monitor-Modus für alle ausgewählten 
Spuren in der Session umzuschalten, drücken Sie 
Wahl + Umschalt (Mac) oder Alt + Umschalt 
(Windows) und klicken auf die TrackInput-
Schaltfläche einer ausgewählten Spur.

Sie haben folgende Möglichkeiten, den Zustand 
aller scharfgeschalteten Spuren über die 
TrackInput-Schaltfläche zu ändern:

 Um alle scharfgeschalteten Spuren auf Auto 
Input-Monitoring umzuschalten, wählen Sie 
Track > Set Record Tracks to Auto Input.

 Um alle scharfgeschalteten Spuren auf Input 
Only-Monitoring umzuschalten, wählen Sie 
Track > Set Record Tracks to Input Only.

Disable Input When Disarming Track

Wenn in den „Operation Preferences“ die Option 
Disable Input When Disarming Track (unter 
„Stop“) aktiviert ist, wird das TrackInput-
Monitoring immer deaktiviert, wenn die 
Scharfschaltung einer Spur aufgehoben wird. Dies 
ist in bestimmten Arbeitsabläufen hilfreich, 
beispielsweise wenn Sie auf einer Reihe von 
Spuren nacheinander aufnehmen.

Wenn Sie diese Option deaktivieren, können beim 
Deaktivieren der Record Enable-Schaltfläche der 
Spur die TrackInput-Schaltflächen aktiviert 
bleiben.

Festlegen des Abhörpegels 
für Aufnahme und Wiedergabe
In Pro Tools sind für das Monitoring jeder 
Audiospur zwei verschiedene Fader-Pegel 
gespeichert: einer für die scharfgeschaltete Spur 
und einer für die nicht scharfgeschaltete Spur. 

In Pro Tools werden diese beiden Zustände für 
Fader-Pegel automatisch gespeichert. Wenn Sie 
eine Fader-Einstellung bei scharfgeschalteter Spur 
ändern und anschließend die Scharfschaltung für 
die Spur aufheben, kehrt der Fader auf seinen 
Wiedergabepegel zurück.

Bei scharfgeschalteten Audiospuren werden die 
dazugehörigen Fader im Mix-Fenster rot angezeigt 
und geben somit an, dass der Monitor-Pegel für die 
Aufnahme aktiv ist.

Link Record and Play Faders
Wenn in den „Operation Preferences“ die Option 
Link Record and Play Faders aktiviert ist, werden 
die Aufnahme- und Wiedergabepegel für 
Audiospuren nicht von Pro Tools gespeichert. In 
diesem Fall hat das Scharfschalten einer Audiospur 
keine Auswirkung auf den Fader-Pegel für die Spur. 
Auf diese Weise bleibt Ihr Mix unabhängig von 
Aufnahme oder Wiedergabe immer einheitlich.

Drücken Sie Umschalt + I, um die 
TrackInput-Schaltfläche für alle Spuren zu 
aktivieren, auf denen sich der Edit-Cursor 
oder eine Edit-Selektion befindet.

Um scharfgeschaltete Spuren zwischen Auto 
Input- und Input Only-Monitoring 
umzuschalten, drücken Sie Wahl + K (Mac) 
bzw. Alt + K (Windows).
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Senken der Monitoring-Latenz
Im Monitoring-Signal kommt es unweigerlich zu 
Audioverzögerungen oder Latenzen (wenn auch 
nur einige Samples) aufgrund des 
Konvertierungsvorgangs eines analogen Signals in 
ein digitales Signal (Eingang) und umgekehrt 
(Ausgang). Aufgrund von Mixer-Konfigurationen 
und -verarbeitungen kann es zu zusätzlichen 
Latenzen kommen.

Avid HDX-Systeme weisen zusätzliche Latenzen 
auf, wenn Native-Plug-Ins verwendet werden, 
da diese Plug-Ins auch den Hostprozessor des 
Computers verwenden.

Da hostbasierte Pro Tools-Systeme den 
Hostprozessor des Computers für die Verarbeitung, 
Wiedergabe und Aufnahme von Audiodaten 
verwenden, tritt im System eine kurze Latenz auf. 
So kann es beispielsweise zu einer hörbaren 
Verzögerung zwischen dem eingehenden und 
ausgehenden Signal kommen, wenn die Aufnahme 
über Pro Tools abgehört wird. 

Mit Pro Tools treten die folgenden Latenzen auf:

• Bei virtuellen Instrumenten-Plug-Ins tritt bei der 
Umwandlung von MIDI-Signalen in 
Audiosignale bei allen Pro Tools-Systemen 
Latenz auf (etwa wenn Sie ein virtuelles 
Instrument live spielen und die Ausgabe des 
Instruments abhören).

• Pro Tools-Systeme weisen eine Monitoring-
Latenz vom Eingang zum Ausgang auf 
sämtlichen scharfgeschalteten Spuren oder 
Auxiliary-Eingängen mit Live-Signalen auf.

• Pro Tools|HDX-Systeme weisen eine 
Monitoring-Latenz bei Spuren mit einem oder 
mehreren hostbasierten Plug-Ins auf. 

Die Latenz steht in direktem Zusammenhang mit 
der H/W Buffer Size-Einstellung: Je größer der 
Puffer, desto höher die Latenz. Sie können 
das Ausmaß der Abhörlatenz senken, indem Sie 
die H/W Buffer Size-Einstellung herabsetzen. 
Es kommt jedoch auch bei der kleinsten 
Puffergröße zu einer gewissen Latenz. 

Außerdem wird durch das Senken der Puffergröße 
die Anzahl der Audiospuren begrenzt, die ohne 
Leistungsstörungen gleichzeitig aufgenommen 
werden können.

Es kann Situationen geben, in denen Sie einen 
größeren Puffer benötigen, etwa wenn Sie eine 
höhere Anzahl von Spuren mit mehr Plug-Ins 
haben. Generell ist jedoch die kleinstmögliche 
Puffergröße zu empfehlen, wenn während 
Aufnahme und Monitoring Latenzen bestehen.

Die Latenz tritt nicht auf, wenn Sie vor dem 
Routen auf Pro Tools eine Aufnahmequelle über 
einen externen Mixer abhören.

So stellen Sie die Hardware-Puffergröße ein:

1 Wählen Sie Setup > Playback Engine.

2 Wählen Sie im H/W Buffer Size-Popup-Menü 
die gewünschte Puffergröße.

3 Klicken Sie auf OK.

Weitere Informationen zur H/W Buffer Size-
Einstellung finden Sie unter „Hardware-
Puffergröße“ auf Seite 54.

Computer mit langsameren CPUs können 
möglicherweise nur eine H/W Buffer Size-
Einstellung mit einer Puffergröße von 
mindestens 512 Samples verwenden, ohne 
dass Leistungsprobleme auftreten.
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Aufnehmen mit 
Verzögerungsausgleich
Generell sollten Sie mit aktiviertem 
Verzögerungsausgleich (Delay Compensation) 
aufnehmen, um eine phasenkohärente zeitliche 
Abstimmung auf Spuren mit unterschiedlichen 
DSP-Verzögerungen anzuwenden. Jedoch sollten 
Sie im Allgemeinen die Verwendung von Inserts 
auf Aufnahmespuren oder Spuren, die zum Steuern 
der Pegel von Cue-Mixes verwendet werden, 
vermeiden. Weitere Informationen finden Sie unter 
„Verzögerungsausgleich“ auf Seite 1024.

Latenzfreies Monitoring
(Nur Mbox, Mbox 2, Mbox Mini und 
Mbox 2 Mini)

Mit Mbox (3. Generation), Mbox 2, Mbox Mini 
und Mbox 2 Mini können Sie die analogen 
Eingangssignale während der Aufnahme ohne 
Latenz abhören. Dieses latenzfreie analoge 
Monitoring können Sie mit dem Mix-Regler an der 
Vorderseite der Mbox steuern. Mit diesem Regler 
können Sie das Verhältnis zwischen dem analogen 
Eingang und der Pro Tools-Wiedergabe mixen 
und anpassen. Weitere Informationen finden Sie 
im Benutzerhandbuch Ihres Systems.

Low Latency Monitoring
(Nur Pro Tools|HD Native, 003, 003 Rack, 
003 Rack+, Mbox Pro, Mbox Pro 2 und 
Core Audio- und ASIO-Interfaces mit 
integrierten Mixern)

Pro Tools|HD Native-, 003-, 003 Rack-, 003 Rack+-, 
Mbox Pro- und Mbox Pro 2-Systeme können die 
Low Latency Monitoring-Option für so viele Spuren 
zur Aufnahme mit extrem kurzer Abhörlatenz 
nutzen, wie das jeweilige System unterstützt.

Ebenso können bestimmte Core Audio- und ASIO-
Audio-Interfaces, die einen Mixer integriert haben 
(etwa RME Fireface oder MOTU 828), die Low 
Latency Monitoring-Option nutzen.

Die Niedriglatenz-Monitoring-Option wird nur für 
Spuren verwendet, die Eingangssignale von einem 
physischen Ausgang (nicht von einem internen 
Bus) erhalten.

So verwenden Sie Niedriglatenz-Monitoring:

1 Sie haben folgende Möglichkeiten:

• Weisen Sie bei HD Native-Systemen jede Spur 
dem ausgewählten Niedriglatenz-
Monitoringpfad zu, wie im I/O Setup-Dialogfeld 
auf der Output-Registerkarte eingestellt (siehe 
„Niedriglatenz-Monitoring“ auf Seite 80). Nur 
diesen Ausgängen zugewiesene Spuren 
verwenden Niedriglatenz-Monitoring.

• Weisen Sie in allen anderen Systemen jeden 
Spurausgang entweder Ausgang 1 oder 
Ausgang 2 (mono) oder beiden (stereo) zu. Nur 
diesen Ausgängen zugewiesene Spuren 
verwenden Niedriglatenz-Monitoring.

2 Schalten Sie Audiospuren scharf, indem Sie auf 
die entsprechenden Scharfschalten-
Schaltflächen klicken.

3 Wählen Sie Options > Low Latency Monitoring. 

Wenn Ihre Core Audio- oder ASIO-
Hardware über keinen integrierten Mixer 
verfügt, funktioniert das Niedriglatenz-
Monitoring nicht. Wenn Sie das 
Niedriglatenz-Monitoring bei Verwendung 
solcher Hardware aktivieren, ist das 
Monitoring bei scharfgeschalteten Spuren in 
Pro Tools nicht verfügbar.
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Bei der Aktivierung der Niedriglatenz-Monitoring-
Option werden alle Plug-Ins und Sends, die den 
scharfgeschalteten Spuren (die wiederum bei 
HD Native-Systemen auf den ausgewählten 
Niedriglatenz-Monitoringpfad bzw. bei allen 
anderen Systemen auf die Ausgänge 1 und 2 
geroutet sind) zugewiesen sind, automatisch auf 
„Bypass“ geschaltet. Diese Einstellung muss 
bestehen bleiben. Außerdem werden diese Spuren 
nicht auf den Pegelanzeigen für Master-Fader 
registriert.

Niedriglatenz-Monitoring und 
Bounce To Disk

Wenn die Low Latency Monitoring-Option 
aktiviert ist, findet der Bounce to Disk-Befehl 
nur auf Audiospuren Anwendung. Auxiliary-
Eingangs-Spuren und Instrumentenspuren werden 
ignoriert. Wenn Sie Auxiliary-Eingangs-Spuren 
und Instrumentenspuren aufnehmen möchten, 
deaktivieren Sie die Low Latency Monitoring-
Option, bevor Sie den Bounce to Disk-Befehl 
ausführen. 

Während eines Bounce auf Festplatte können 
externe Eingänge nicht aufgenommen 
werden. Um den Bounce to Disk-Befehl auch 
auf externe Eingänge anzuwenden, müssen 
Sie diese vor dem Ausführen in neuen 
Audiospuren aufzeichnen (siehe „Bounce to 
Disk“ auf Seite 1141).



Pro Tools-Referenzhandbuch454



Kapitel 21: Audioaufnahme 455

Kapitel 21: Audioaufnahme

In Pro Tools wird Audiomaterial in Audiospuren 
aufgenommen. Audiospuren können Mono-, 
Stereo- oder Mehrkanalspuren sein – je nach 
Aufnahmequelle. 

Wenn Sie eine Monoquelle aufnehmen, nehmen 
Sie auf einer einzigen Mono-Audiospur in 
Pro Tools auf. Dabei wird eine Mono-Audiodatei 
auf der Festplatte gespeichert und der 
dazugehörige Clip in der Playlist und der Clipliste 
angezeigt.

Wenn Sie eine Stereo-Audioquelle aufnehmen, 
nehmen Sie auf einer einzigen Stereo-Audiospur 
in Pro Tools auf. Für den linken und den rechten 
Kanal der Spur werden eigene Mono-
Audiodateien auf die Festplatte geschrieben; 
die dazugehörigen Clips werden in den Playlists 
beider Kanäle angezeigt. Diese Dateien werden als 
Stereo-Clip in der Playlist der Spur angezeigt und 
in der Clipliste aufgeführt.

Die Aufnahme einer Mehrkanalquelle auf eine 
Mehrkanalspur (nur Pro Tools HD) erfolgt ähnlich 
wie jene von Stereo-Audiospuren. Für jeden Kanal 
der Spur wird eine einzelne Mono-Audiodatei 
geschrieben. Diese Dateien werden als Clips 
sowohl in der Playlist der Spur als auch in der 
Clipliste angezeigt (siehe „Mehrkanal-
Audiospuren“ auf Seite 1171). 

Vor der Aufnahme
Bevor Sie mit der Aufnahme in Pro Tools 
beginnen, müssen Sie Ihr Pro Tools-System, eine 
Session und mindestens eine Spur für die 
Aufnahme einrichten. Außerdem müssen Sie 
konfigurieren, wie Pro Tools den Eingang, den Sie 
aufnehmen möchten, abhört. Weitere 
Informationen finden Sie unter Kapitel 20: 
„Aufnahme-Setup“.
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Grundlegende 
Aufnahmeschritte

So nehmen Sie eine Audiospur auf:

1 Wählen Sie im Input Path-Selektor der Spur den 
Audio-Eingangspfad, den Sie aufnehmen 
möchten (siehe „Zuweisen von Hardware-I/O 
auf einer Spur“ auf Seite 441).

2 Wählen Sie im Output Path-Selektor der Spur 
den Hauptausgangspfad aus.

3 Klicken Sie auf die Record Enable-Schaltfläche 
für die Audiospur. (Sie leuchtet dann rot auf.)

4 Stellen Sie den Ausgangspegel Ihrer 
Audioquelle (Instrument, Mischpult oder 
Vorverstärker) ein. Überwachen Sie die Pegel 
der Spur in Pro Tools, um sicherzustellen, dass 
die Spitzenpegel zwischen mindestens –6 dB 
und –12 dB der Eingangspegelanzeige liegen, 
ohne dass die Übersteuerungsanzeige auf dem 
Audio-Interface ausgelöst wird.

5 Sie haben folgende Möglichkeiten:

• Stellen Sie im Mix-Fenster die Lautstärke und 
die Pan-Fader der Spur ein. Diese Einstellungen 
dienen ausschließlich Monitoring-Zwecken und 
wirken sich nicht auf aufgenommenes Material 
aus.

• Stellen Sie im Output-Fenster der Spur 
Lautstärkefader und Pan-Regler ein. Diese 
Einstellungen dienen ausschließlich 
Monitoring-Zwecken und wirken sich nicht auf 
aufgenommenes Material aus. (Siehe „Output-
Fenster für Spuren und Sends“ auf Seite 1009.)

6 Wählen Sie Window > Transport, um das 
Transport-Fenster anzuzeigen. Klicken Sie auf 
„Return to Zero“, um an den Session-Anfang zu 
gehen. 

7 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten. Die Record-Schaltfläche 
blinkt rot, um die Aufnahmebereitschaft von 
Pro Tools anzuzeigen.

8 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist (siehe 
„Aufnahmemodi“ auf Seite 436).

9 Klicken Sie auf Play oder drücken Sie die 
Leertaste, wenn Sie mit der Aufnahme 
beginnen möchten.

Scharfschalten einer Spur im Mix-Fenster

Transport-Fenster

Zurück zu Null Schnellvorlauf (Fast Forward)

Zum Ende

Online Stopp
Play

Aufnahme

Rewind
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Wenn Sie einen Countoff benutzen, zählt Pro Tools 
die angegebene Anzahl an Einheiten vor und 
beginnt anschließend mit der Aufnahme. Siehe 
„Aufnehmen mit dem Metronom“ auf Seite 430.

10 Nehmen Sie Ihre Performance auf.

11 Klicken Sie im Transport-Fenster auf „Stop“ 
oder drücken Sie die Leertaste, wenn Sie mit 
der Aufnahme fertig sind.

Das neu aufgenommene Audiomaterial wird auf die 
Festplatte geschrieben und als Audio-Clip in der 
Playlist der Spur und in der Clipliste angezeigt.

So geben Sie die Audiospur wieder:

1 Klicken Sie auf die Record Enable-Schaltfläche 
der Audiospur, um die Scharfschaltung 
aufzuheben. Die Lautstärke-Fader der Spur 
übernehmen nun die Funktion der 
Lautstärkeregelung für die Wiedergabe.

2 Um mit der Wiedergabe vom Anfang der 
Session an zu beginnen, klicken Sie im 
Transport-Fenster auf „Return to Zero“.

3 Klicken Sie im Transport-Fenster auf „Play“ 
oder drücken Sie die Leertaste, um die 
Wiedergabe zu starten.

Rückgängigmachen oder 
Abbrechen einer Aufnahme
Wenn die Aufnahme einer Audiospur beendet und 
der Transport angehalten ist, können Sie den 
Aufnahme-Take rückgängig machen.

So machen Sie eine Audioaufnahme rückgängig:

 Halten Sie den Transport an und wählen Sie 
Edit > Undo Record Audio. 

Die Playlist der Spur wird in ihren ursprünglichen 
Zustand zurückversetzt und das Material wird wie 
folgt entfernt:

• Im Aufnahmemodus „Normal“ wird nur der 
jüngste Take entfernt.

• Im Loop-Aufnahmemodus werden alle Takes 
jedes Aufnahmedurchgangs entfernt.

• Im QuickPunch-, TrackPunch- oder 
DestructivePunch-Modus werden alle Punches 
des letzten Aufnahmedurchgangs entfernt.

Wenn keine Aktionen rückgängig gemacht werden 
können, wird in Grau die Meldung Can't Undo 
angezeigt.

Befindet sich eine scharfgeschaltete Spur im 
Monitor-Modus „Auto Input“, können Sie 
das eingegebene Material auch dann 
abhören, wenn der Transport angehalten ist. 
Wenn Sie auf „Play“ klicken, wird die Spur 
automatisch in den Playback-Modus, beim 
Anhalten der Wiedergabe oder beim 
Schalten in die Punch-Aufnahme zurück in 
den Input-Modus geschaltet. Weitere 
Informationen finden Sie unter „Auto Input-
Monitoring“ auf Seite 448.

Wenn Sie einen Aufnahmedurchgang 
während der Aufnahme rückgängig machen, 
entfernt Pro Tools alle zuvor rückgängig 
gemachten Aufnahmedurchgänge aus der 
Session und gibt Ihnen die Möglichkeit, den 
vorherigen Aufnahmedurchgang von der 
Festplatte zu löschen.
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Abbrechen eines Aufnahme-
Takes
Es ist möglich, den aktuellen Take während der 
Aufnahme zu verwerfen. Dadurch wird das bis 
dahin aufgenommene Audiomaterial von der 
Festplatte entfernt und der Clip aus der Playlist der 
Spur und der Clipliste gelöscht. Wenn Sie den 
Loop-Aufnahmemodus verwenden, werden alle 
Takes jedes Aufnahmedurchgangs entfernt. 
Das Abbrechen einer Aufnahme ist im 
Destructive-Aufnahmemodus nicht erlaubt. 

So brechen Sie einen Aufnahme-Take während der 
Aufnahme ab:

 Drücken Sie Befehl + Punkt (.) (Mac) bzw. 
Strg + Punkt (.) (Windows), bevor der Transport 
angehalten wird.

Aufnehmen von mehreren 
Audiospuren
Pro Tools kann mehrere Audiospuren gleichzeitig 
aufnehmen. Die Höchstanzahl hängt davon ab, 
wie viele Spuren Ihr System bereitstellt. Um 
mehrere Spuren aufzunehmen, müssen Sie jede 
einzelne zuerst konfigurieren und scharfschalten. 
Folgen Sie dabei den Anweisungen unter 
„Grundlegende Aufnahmeschritte“ auf Seite 456.

Für jede scharfgeschaltete Spur wird eine neue 
Audiodatei auf die Festplatte geschrieben und ein 
neuer Clip erstellt, der sowohl in der Playlist der 
Spur als auch in der Clipliste angezeigt wird.

Tastenkombinationen für die 
Aufnahme
Neben der Möglichkeit, die Aufnahme im 
Transport- oder Edit-Fenster durch Klicken auf die 
Record-Schaltfläche scharfzuschalten, können Sie 
auch die folgenden Tastenkombinationen 
verwenden, um die Aufnahme scharfzuschalten 
und zu starten:

• Drücken Sie F12, um die Aufnahme sofort 
zu starten.

• Drücken Sie Befehl + Leer (Mac) bzw. Strg + 
Leer (Windows), um die Aufnahme zu starten.

• Drücken Sie 3 auf dem Ziffernblock 
(Ziffernblockmodus auf Transport eingestellt), 
um die Aufnahme zu starten.

Wenn Sie über ein Pro Tools-System mit 
mehreren Laufwerken verfügen und mehrere 
Spuren gleichzeitig aufnehmen möchten, 
können Sie festlegen, dass das 
Systemlaufwerk ausschließlich für den 
Transfer genutzt wird, um eine optimale 
Leistung zu erzielen.

Wenn Sie auf Mac-Systemen die F12-Taste zur 
Aufnahme verwenden möchten, muss die 
Dashboard-Funktion deaktiviert oder neu 
zugewiesen werden. Ausführliche 
Informationen finden Sie im Benutzerhandbuch.

Wenn Sie auf Mac-Systemen die Kombination 
Befehls- und Leertaste zur Aufnahme 
verwenden möchten, muss die Spotlight-
Funktion deaktiviert oder neu zugewiesen 
werden. Ausführliche Informationen finden Sie 
im Benutzerhandbuch.

Um die Aufnahme bei halber Geschwindigkeit 
zu starten, drücken Sie Befehl + Umschalt + 
Leer (Mac) bzw. Strg + Umschalt + Leer 
(Windows). Siehe „Aufnahme mit halber 
Geschwindigkeit“ auf Seite 478.
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Prime for Record-Modus
Wenn Sie eine große Anzahl Spuren oder Kanäle 
aufnehmen oder während der Aufnahme viele 
Spuren abspielen, kann es etwas länger dauern, bis 
Pro Tools mit der Aufnahme beginnt. Um diese 
Verzögerung zu vermeiden, schalten Sie Pro Tools 
vor Beginn der Aufnahme in den Prime for 
Record-Modus.

So aktivieren Sie den Prime for Record-Modus und 
beginnen mit der Aufnahme:

1 Klicken Sie im Transport-Fenster auf „Record“. 
Die Record-Schaltfläche beginnt zu blinken.

2 Sie haben folgende Möglichkeiten:

• Um Pro Tools in den Prime for Record-Modus 
zu versetzen, klicken Sie bei gedrückter 
Wahltaste (Mac) oder Alt-Taste (Windows) in 
das Transport-Fenster.

• Klicken Sie mit der rechten Maustaste auf die 
Play-Schaltfläche und wählen Sie Prime for 

Record.

Die Stop-Schaltfläche leuchtet auf und sowohl die 
Play- als auch die Record-Schaltfläche blinkt.

3 Um sofort mit der Aufnahme zu beginnen, 
klicken Sie auf „Play“. 

4 Klicken Sie auf „Stop“, um die Aufnahme 
zu beenden.

Festlegen der Punch- und 
Loop-Punkte
Die Start- und Endpunkte eines Aufnahmebereichs 
für Punch- und Loop-Aufnahme können 
folgendermaßen festgelegt werden:

• Selektieren Sie einen Bereich in der Playlist 
einer Spur (mit aktivierter Option Options > Link 

Timeline and Edit Selection).

• Wählen Sie in einer Zeitbasis-Leiste einen 
Bereich aus.

• Ziehen Sie die Timeline-Selektionsmarker in die 
Leiste.

• Geben Sie Start- und Endzeit in das Transport-
Fenster ein.

• Rufen Sie eine Memory Location ab, die eine 
Edit-Selektion enthält (mit aktivierter Option 
Options > Link Timeline and Edit Selection).

So legen Sie den Aufnahmebereich in der Playlist 
einer Spur fest:

1 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

2 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

3 Sie haben folgende Möglichkeiten:

• Selektieren Sie mit dem Selector-Tool den 
Aufnahmebereich in der Playlist einer Spur.

Verwenden Sie bei einer Synchronisation mit 
dem Timecode den Prime for Record-Modus, 
um eine große Anzahl von Spuren 
aufzunehmen oder wiederzugeben. Auf diese 
Weise wird die Zeit verkürzt, die für das 
Verankern mit dem Timecode benötigt wird.

Playlist-Selektion
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• Wenn der Aufnahmebereich mit dem Clip 
übereinstimmt, selektieren Sie den gesamten 
Clip.

So legen Sie den Aufnahmebereich in einer 
Zeitbasis-Leiste fest:

1 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

2 Ziehen Sie den Aufnahmebereich in eine 
beliebige Zeitbasis-Leiste.

Timeline-Selektionsmarker
Wenn Spuren scharfgeschaltet sind, werden die 
Timeline-Selektionsmarker für Start- und Endzeit 
in der Haupt-Zeitbasis-Leiste als rote Pfeile nach 
oben oder nach unten angezeigt. Wenn keine 
Spuren scharfgeschaltet sind, werden die 
Timeline-Selektionsmarker blau angezeigt.

Die Timeline-Selektionsmarker können zur 
Einstellung der Aufnahme- und 
Wiedergabebereiche (entweder einzeln oder 
gleichzeitig) verschoben werden.

So legen Sie den Aufnahmebereich durch Ziehen 
der Timeline-Selektionsmarker fest:

1 Legen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ fest, wenn Sie die Timeline-
Selektionsmarker auf den aktuellen Grid-Wert 
ausrichten möchten. 

2 Ziehen Sie den ersten Timeline-
Selektionsmarker (Pfeil nach unten) zum 
Startpunkt des Bereichs.

Sie können den Start- und Endpunkt auch 
während der Wiedergabe festlegen. Drücken 
Sie zum Festlegen des Startpunktes die Nach-
unten-Pfeiltaste und zum Setzen des 
Endpunktes die Nach-oben-Pfeiltaste. 
Beachten Sie, dass so festgelegte Start- und 
Endpunkte im Grid-Modus nicht am Raster 
ausgerichtet werden.

Timeline-Selektion:

Wenn das Selector-Tool nicht aktiv ist, 
brauchen Sie es nicht manuell aufzurufen. 
Andere Edit-Tools (wie etwa das Time 
Grabber-Tool) verwandeln sich automatisch 
in das Selector-Tool, wenn sie in Zeitbasis-
Leisten verwendet werden.

Timeline-Selektionsmarker in der Haupt-Zeitbasis-
Leiste

Ziehen eines Timeline-Selektionsmarkers (Startpunkt) 
in der Haupt-Zeitbasis-Leiste
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3 Ziehen Sie den zweiten Timeline-
Selektionsmarker (Pfeil nach oben) zum 
Endpunkt des Bereichs.

Start-, End- und Length-Feld
In der erweiterten Darstellung des Transport-
Fensters können die Start- und Endzeit, die Länge 
sowie die Einstellungen für Pre- und Post-Roll 
angezeigt werden. Die Einstellung eines 
Aufnahme- bzw. Wiedergabebereichs wird in 
diesen Feldern angezeigt.

In Start- und End-Feld können Sie Positionen zum 
Festlegen des Aufnahme- oder 
Wiedergabebereichs eingeben. Die Timeline-
Selektionsmarker in der Haupt-Zeitbasis-Leiste 
werden dementsprechend aktualisiert.

So stellen Sie den Aufnahmebereich durch das 
Eingeben von Start- und Endzeit im Transport-
Fenster ein:

1 Um die Start- und Endzeit sowie die Länge 
anzuzeigen, haben Sie folgende Möglichkeiten:

• Wählen Sie View > Transport > Expanded.

• Halten Sie die Umschalttaste gedrückt und 
klicken Sie im Transport-Fenster auf die 
Expand/Collapse-Schaltfläche („+“).

2 Sie haben folgende Möglichkeiten:

• Klicken Sie im Transport-Fenster in das Start-
Feld.

• Drücken Sie Wahl + Schrägstrich (/) (Mac) bzw. 
Alt + Schrägstrich (/) (Windows) auf dem 
Ziffernblock, um das Start-Feld im Transport-
Fenster auszuwählen.

Wenn der Aufnahmebereich bereits die 
richtige Länge hat und nur noch verschoben 
werden muss, ziehen Sie einen der Timeline-
Selektionsmarker bei gedrückter Wahltaste 
(Mac) oder Alt-Taste (Windows), um beide 
Marker unter Beibehaltung der Länge an 
einer anderen Position zu platzieren.

Transport-Fenster mit Anzeige von Start-, End- und 
Length-Feld
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3 Geben Sie die Startposition ein und drücken Sie 
Wahl + Schrägstrich (/) (Mac) bzw. Alt + 
Schrägstrich (/) (Windows) auf dem 
Ziffernblock, um den Wert einzugeben und 
automatisch zum End-Feld zu springen.

4 Geben Sie nun die Endposition ein und drücken 
Sie die Eingabetaste, um den Wert zu bestätigen.

Lesezeichen-Positionen
Sie können Edit-Selektionen als Memory Locations 
speichern, worin auch die aktuellen Pre- und Post-
Roll-Werte enthalten sein können.

So speichern Sie eine Edit-Selektion mit einer 
Memory Location:

1 Stellen Sie sicher, dass Options > Link Timeline 

and Edit Selection ausgewählt ist.

2 Stellen Sie einen Aufnahmebereich ein, indem 
Sie eine Edit- oder Timeline-Selektion treffen 
oder im Transport-Fenster Start- und Endzeit 
eingeben.

3 Um die Werte für Pre- und Post-Roll zu speichern, 
aktivieren Sie die Pre- und Post-Roll-Längen 
und stellen Sie sie ein. Dazu können Sie diese 
entweder im Transport-Fenster eingeben oder die 
Pre- und Post-Roll-Flags auf die Leiste ziehen, 
die die Haupt-Zeitskala darstellt (siehe „Einstellen 
von Pre- und Post-Roll“ auf Seite 463).

4 Drücken Sie die Enter-Taste auf dem 
Ziffernblock oder klicken Sie im Edit-Fenster 
auf „Add Marker/Memory Location“.

5 Stellen Sie im New Memory Location-
Dialogfeld „Time Properties“ auf Selection und 
wählen Sie gegebenenfalls unter „General 
Properties“ die Pre/Post Roll Times-Option.

6 Geben Sie einen Namen für die neue Memory 
Location ein.

7 Klicken Sie auf OK.

Wechseln Sie mithilfe der Punkttaste (.) 
oder der Nach-links- und Nach-rechts-
Pfeiltasten zwischen den verschiedenen 
Feldern mit Zeitangaben für Start und 
Ende. Verwenden Sie die Nach-oben- oder 
Nach-unten-Pfeiltaste, um die 
Zahlenwerte zu senken bzw. zu erhöhen.

Weitere Informationen zu Memory Locations 
finden Sie unter Kapitel 36: „Memory 
Locations“.

New Memory Location-Dialogfeld
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So rufen Sie eine Edit-Selektion mit einer Memory 
Location ab:

1 Vergewissern Sie sich, dass Options > Link 

Timeline and Edit Selection ausgewählt ist.

2 Wählen Sie Windows > Memory Locations.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie im Memory Locations-Fenster auf 
den Namen oder die Nummer der Memory 
Location.

• Geben Sie auf dem Ziffernblock einen Punkt (.), 
die Nummer der entsprechenden Memory 
Location und anschließend wieder einen Punkt 
(.) ein. (Siehe „Ziffernblockmodus“ auf 
Seite 28).

Die mit der Memory Location gespeicherten Start- 
und Endzeiten und die Pre- und Post-Roll-
Einstellungen werden aufgerufen.

Einstellen von Pre- und Post-
Roll
Pre- und Post-Roll-Zeiten werden in der Leiste, die 
die Haupt-Zeitskala darstellt, als Flags angezeigt. 
Wenn Pre- und Post-Roll aktiviert ist, sind die 
Flags grün, ansonsten sind sie grau.

Pre- und Post-Roll können im Transport-Fenster, 
in der Playlist oder in der Zeitbasis-Leiste einer 
Spur oder durch Abrufen einer Memory Location 
eingestellt werden.

Memory Locations-Fenster

Grüne Pre- und Post-Roll-Flags (aktiviert) in der 
Haupt-Zeitbasis-Leiste
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Einstellen von Pre- und Post-Roll 
im Transport-Fenster
Pre- und Post-Roll können im Transport-Fenster 
aktiviert und eingestellt werden.

So werden Pre- und Post-Roll-Zeiten im Transport-
Fenster eingestellt und aktiviert:

1 Wählen Sie View > Transport > Expanded.

2 Klicken Sie im Transport-Fenster in das Pre-
Roll-Feld.

3 Geben Sie den Pre-Roll-Wert ein und drücken 
Sie die Schrägstrichtaste auf dem Ziffernblock, 
um den Wert festzulegen und automatisch zum 
Post-Roll-Feld zu springen.

4 Geben Sie nun den Post-Roll-Wert ein und 
drücken Sie die Eingabetaste, um ihn 
zu bestätigen.

5 Um Pre- oder Post-Roll zu aktivieren, klicken 
Sie auf die entsprechende Schaltfläche, die 
farbig aufleuchtet.

Einrichten von Pre- und Post-Roll 
in einer Playlist
Sie können das Selector-Tool zum Aktivieren bzw. 
Deaktivieren von Pre- und Post-Roll verwenden, 
indem Sie in die Playlist einer Spur klicken.

So wird Pre- und Post-Roll durch Klicken in eine 
Playlist eingestellt und aktiviert:

1 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Selektieren Sie mit dem Selector-Tool den 
Aufnahmebereich in der Playlist einer Spur.

3 Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) mit dem Selector-
Tool vor dem selektierten Abschnitt an die 
Stelle der Spur-Playlist, wo Pre-Roll beginnen 
soll.

4 Klicken Sie bei gedrückter Wahltaste (Mac) oder 
Alt-Taste (Windows) mit dem Selector-Tool 
hinter dem selektierten Abschnitt an die Stelle der 
Spur-Playlist, wo Post-Roll enden soll.

So deaktivieren Sie Pre- und Post-Roll durch 
Klicken in eine Playlist:

1 Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) mit dem Selector-
Tool in der Nähe des Starts auf die Edit-
Selektion, um Pre-Roll zu deaktivieren.

2 Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) mit dem Selector-
Tool in der Nähe des Endes auf die Edit-
Selektion, um Post-Roll zu deaktivieren.

Pre-Roll aktiviert für 2 Schläge, Post-Roll deaktiviert

Wechseln Sie mithilfe der Punkttaste (.) oder 
der Nach-links- und Nach-rechts-Pfeiltasten 
zwischen den Zeitfeldern für Pre- und Post-
Roll. Verwenden Sie die Nach-oben- oder 
Nach-unten-Pfeiltaste, um die Zahlenwerte 
zu senken bzw. zu erhöhen.

In der Timeline können Sie Pre- und Post-
Roll auf Null zurücksetzen. Ziehen Sie 
zunächst das Pre-Roll-Flag an die 
Startmarke der Timeline-Selektion und 
ziehen Sie dann das Post-Roll-Flag an die 
Endmarke der Timeline-Selektion.



Kapitel 21: Audioaufnahme 465

3 Ziehen Sie das Pre-Roll-Flag an die Startmarke 
in der Timeline-Selektion.

4 Ziehen Sie das Post-Roll-Flag an die Endmarke 
in der Timeline-Selektion.

Aktivieren von Pre- und Post-Roll 
im Options-Menü
Pre- und Post-Roll können zusammen im Options-
Menü aktiviert bzw. deaktiviert werden.

So aktivieren Sie Pre- und Post-Roll zusammen im 
Options-Menü:

 Wählen Sie Options > Pre/Post-Roll.

Ziehen von Pre- und Post-Roll-
Flag in der Zeitbasis-Leiste
Pre- und Post-Roll-Flag können einzeln oder 
gleichzeitig in der Haupt-Zeitbasis-Leiste an die 
gewünschte Position gezogen werden.

So legen Sie die Längen von Pre- und Post-Roll 
durch Ziehen in der Haupt-Zeitbasis-Leiste fest:

1 Wenn Pre- und Post-Roll-Flag am aktuellen 
Grid-Wert ausgerichtet werden sollen, legen Sie 
den Edit-Modus auf „Grid“ fest.

2 Ziehen Sie das Pre-Roll-Flag an die neue 
Position in der Leiste.

3 Ziehen Sie das Post-Roll-Flag an eine neue 
Position in der Zeitbasis-Leiste.

Punch-Aufnahme von 
Audiomaterial über einen 
festgelegten Bereich
Sie können Pro Tools auf die automatische Punch-
Aufnahme über einen bestimmten Bereich in einer 
Audiospur einstellen (etwa zum Ersetzen eines 
Abschnitts aus einer aufgenommenen Spur). Start- 
und Endpunkt des Bereichs (Punch-In und Punch-
Out) müssen vor der Aufnahme festgelegt werden.

Für die Einstellung von Aufnahme- und 
Wiedergabebereichen stehen mehrere Methoden 
zur Verfügung (siehe „Festlegen der Punch- und 
Loop-Punkte“ auf Seite 459). Am einfachsten 
dürfte es sein, den Aufnahmebereich in der Playlist 
der Spur zu selektieren.

Ziehen eines Pre-Roll-Flags in einer Zeitbasis-Leiste

Um Pre- und Post-Roll-Wert auf die gleiche 
Länge festzulegen, ziehen Sie entweder das 
Pre- oder das Post-Roll-Flag bei gedrückter 
Wahltaste (Mac) oder Alt-Taste (Windows) 
in der Leiste. Wenn Sie das aktivierte Flag 
ziehen, wird das deaktivierte Flag 
automatisch auf denselben Wert gesetzt und 
an die entsprechende Position verschoben.

Weitere Informationen zum manuellen 
Punch-In/-Out auf scharfgeschalteten 
Spuren während der Wiedergabe finden Sie 
unter Kapitel 23: „Punch-Aufnahmemodi“.

Aufnahme- und Wiedergabebereiche können 
nur dann in der Playlist selektiert werden, 
wenn Edit- und Timeline-Selektion gekoppelt 
sind. (Wählen Sie dazu „Options > Link 
Timeline and Edit Selection“.)
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Die Wiedergabe des Materials beginnt mit der Pre-
Roll (falls aktiviert), wobei die Aufnahme am 
Punch-In-Punkt beginnt. Bei Erreichen 
des Endzeitpunkts (Punch-Out-Punkt) wird 
der Aufnahmemodus automatisch verlassen und 
es wird zur Wiedergabe bis zum angegebenen Post-
Roll-Wert übergegangen. Die automatisierte 
Punch-In/-Out-Funktion stellt daher eine 
leistungsstarke und präzise Methode zur Aufnahme 
bzw. Neuaufnahme auf einer Spur dar.

So führen Sie eine Punch-Aufnahme auf einer 
Audiospur durch:

1 Sie haben folgende Möglichkeiten:

• Wenn Sie nichtdestruktiv aufnehmen möchten, 
vergewissern Sie sich, dass Options > 

Destructive Record nicht aktiviert ist.

• Wenn Sie den angegebenen Aufnahmebereich 
jedoch dauerhaft überschreiben möchten, 
aktivieren Sie Options > Destructive Record.

2 Schalten Sie die Spur scharf.

3 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

4 Ziehen Sie mit dem Selector-Tool über die 
Playlist der Spur oder die Zeitbasis-Leisten, bis 
die Selektion den Punch-Bereich umfasst (siehe 
„Festlegen der Punch- und Loop-Punkte“ auf 
Seite 459).

5 Um bestehendes Spurmaterial bis zum 
Startpunkt bzw. nach dem Endpunkt abhören zu 
können, stellen Sie Pre- und Post-Roll-Zeiten 
ein (siehe „Einstellen von Pre- und Post-Roll“ 
auf Seite 463).

6 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

7 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

Pro Tools startet die Aufnahme am Punch-In-
Punkt (Startpunkt). Bei vorhandener Pre-Roll 
beginnt die Aufnahme, sobald der Punch-In-Punkt 
(Startpunkt) erreicht wird. Die Aufnahme läuft bis 
zum Erreichen des Punch-Out-Punkts (Endpunkt), 
sofern Sie sie nicht vorher manuell anhalten. Bei 
aktiviertem Post-Roll wird die Wiedergabe 
entsprechend der angegebenen Post-Roll-Dauer 
fortgesetzt.

Timeline-Selektion für Punch-Aufnahme mit Pre- und 
Post-Roll

Pre-Roll-Flag

Punch-In Punch-Out 

Post-Roll-Flag

Pre-Roll
aktiviert

Post-Roll aktiviert

Bei der Aufnahme in einem anderen als dem 
Destructive-Aufnahmemodus wird das 
ursprüngliche Material durch die Punch-
Vorgänge nicht dauerhaft ersetzt. Wenn Sie 
den angegebenen Aufnahmebereich jedoch 
dauerhaft überschreiben möchten (und nur 
der letzten Take erhalten bleiben soll), 
aktivieren Sie „Options > Destructive 
Record“.
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Bei einer nicht destruktiven Aufnahme wird eine 
neue Audiodatei auf die Festplatte geschrieben. 
Außerdem wird in der Spur und in der Clipliste ein 
neuer Audioclip angezeigt.

Wenn Sie im Destructive-Aufnahmemodus 
aufnehmen, wird das vorherige Material in der 
bestehenden Audiodatei und dem Clip durch das 
neue Audiomaterial überschrieben.

Monitoring während Punch-Ins

Pro Tools bietet zwei Monitor-Modi für 
Aufnahmen: Auto Input-Monitoring und Input 
Only-Monitoring (siehe „Auswählen eines Record 
Input Monitoring-Modus“ auf Seite 448).

Aufnehmen von zusätzlichen 
Takes
Nachdem die Aufnahme auf eine Audiospur 
beendet ist, können Sie der gleichen Spur 
zusätzliche Takes hinzufügen. Alle dieser 
zusätzlichen Takes können in der Haupt-Playlist 
verwendet werden. Weitere Informationen zum 
Zugriff auf alternative Takes finden Sie unter 
„Alternative Takes“ auf Seite 472.

Bei der Aufnahme zusätzlicher Takes im 
Destructive-Aufnahmemodus wird der 
vorangegangene Take überschrieben. Um das 
Audiomaterial vorheriger Takes beizubehalten, 
nehmen Sie die neuen Takes im Aufnahmemodus 
„Normal (Nondestructive)“ auf.

So zeichnen Sie einen neuen Take nicht destruktiv 
auf der gleichen Spur auf:

1 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist (siehe 
„Aufnahmemodi“ auf Seite 436).

2 Schalten Sie die Spur scharf.

3 Sie haben folgende Möglichkeiten:

• Um vom Beginn der Session an aufzunehmen, 
klicken Sie im Transport-Fenster auf „Return to 
Zero“.

• Aktivieren Sie Options > Link Timeline and Edit 

Selection und klicken Sie auf eine beliebige 
Stelle in der Playlist der Spur, um an diesem 
Punkt mit der Aufnahme zu beginnen.

Weitere Informationen zu Namen von 
Audiodateien und Clips für neue Takes 
finden Sie unter „Konfigurieren von 
Standardnamen für Audiodateien und -
Clips“ auf Seite 439.
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4 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

5 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

6 Klicken Sie auf „Stop“, um die Aufnahme 
zu beenden.

Für den neuen Take wird eine Audiodatei auf die 
Festplatte geschrieben und als Audioclip in der 
Playlist der Spur und in der Clipliste angezeigt.

Das Audiomaterial des ursprünglichen Takes 
verbleibt auf Ihrer Festplatte und steht nach wie 
vor als Clip in der Clipliste zur Verfügung.

So nehmen Sie destruktiv über einen vorherigen 
Take auf:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Options > Destructive Record im 
Destructive Record-Modus. 

• Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Record-Schaltfläche 
und wählen Sie Destructive.

Auf der Record-Schaltfläche wird ein „D“ angezeigt.

2 Schalten Sie die Spur scharf.

3 Sie haben folgende Möglichkeiten:

• Um vom Beginn der Spur an aufzunehmen, 
klicken Sie im Transport-Fenster auf „Return to 
Zero“.

• Aktivieren Sie Options > Link Timeline and Edit 

Selection und klicken Sie auf eine beliebige 
Stelle in der Playlist der Spur, um an diesem 
Punkt mit der Aufnahme zu beginnen.

4 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

5 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

6 Klicken Sie abschließend auf „Stop“, um die 
Aufnahme anzuhalten.

Das Audiomaterial für den neuen Take wird auf 
der Festplatte gespeichert, wobei das Original 
dauerhaft überschrieben wird. Das neue Material 
ersetzt das ursprüngliche Material innerhalb 
des vorhandenen Clips und der Clip wird 
nicht umbenannt.

Informationen zur Aufnahme eines 
bestimmten Spurabschnitts mit präzisem 
Start- und Endpunkt finden Sie unter 
„Punch-Aufnahme von Audiomaterial über 
einen festgelegten Bereich“ auf Seite 465.

Destructive-Aufnahmemodus aktiviert

Informationen zur Aufnahme eines 
bestimmten Spurabschnitts mit präzisem 
Start- und Endpunkt finden Sie unter 
„Punch-Aufnahme von Audiomaterial über 
einen festgelegten Bereich“ auf Seite 465.
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Anhängen von neuem Material 
an das Ende einer Spur
Darüber hinaus gibt es die Möglichkeit, am Ende 
einer Spur neues Material anzuhängen. 

So hängen Sie am Ende einer Spur neues 
Material an:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie im Transport-Fenster auf „Go to 
End“, um das Ende des Spur aufzurufen (es wird 
zum Ende der Session gesprungen).

• Blättern Sie zum Endpunkt des letzten Clips auf 
der Spur.

2 Starten Sie von dort aus die Aufnahme. 

Pro Tools fügt das neue Material am Ende der Spur 
hinzu. Im Destructive-Aufnahmemodus wird das 
neue Material an die Audiodatei und den 
Audioclip des ersten Takes angehängt. Im 
Nondestructive-Aufnahmemodus werden eine 
neue Datei und ein neuer Clip erstellt.

Aufnahme in einer neuen 
Playlist
Anstatt bestehende Audioclips zu überschreiben, 
können Sie neue Takes auch mit der folgenden 
Methode nicht destruktiv auf der gleichen Spur 
aufnehmen: Erstellen Sie eine neue Playlist für die 
Spur und nehmen Sie wie oben beschrieben auf.

Spuren können über mehrere Edit-Playlists verfügen, 
die jeweils eine Liste von in einer bestimmten 
Reihenfolge miteinander verbundenen Clips 
enthalten. Da Playlists mit Gruppen verknüpft sind, 
wirkt sich das Duplizieren oder Auswählen 
alternativer Playlists für eine Spur in einer aktivierten 
Gruppe auf alle Spuren in dieser Gruppe aus.

So nehmen Sie in eine neue Playlist für eine Spur 
auf:

1 Wählen Sie im Playlist-Selektor der Spur die 
New-Option.

2 Geben Sie einen Namen für die neue Playlist 
ein. 

3 Klicken Sie auf OK.

Beim Erstellen einer neuen Playlist wird der 
Spurname durch den neuen Playlist-Namen 
ersetzt. Namen für neue Audiodateien und -Clips 
basieren auf dem Spurnamen.

4 Schalten Sie die Spur scharf.

5 Um am Anfang der Session zu beginnen, 
klicken Sie im Transport-Fenster auf „Return to 
Zero“.

6 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

7 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

8 Klicken Sie auf „Stop“, um die Aufnahme 
zu beenden.

Für den neuen Take wird eine Audiodatei auf die 
Festplatte geschrieben und als Audioclip in der 
neuen Playlist der Spur und in der Clipliste 
angezeigt.

Playlist-Selektor
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Durch Selektieren einer vorherigen Playlist 
über den Playlist-Selektor der Spur wird die 
ursprüngliche Anordnung der Clips in der Spur 
wiederhergestellt. Sämtliche Clips aller Playlists 
stehen jederzeit in der Clipliste zur Verfügung und 
können zwischen Playlists und Spuren beliebig 
kombiniert werden.

Loop-Aufnahme von 
Audiomaterial
In Pro Tools steht eine Loop-Aufnahmefunktion zur 
Verfügung, die es Ihnen ermöglicht, Takes 
nacheinander aufzunehmen, während der gleiche 
Abschnitt immer wieder abgespielt wird. Dabei 
handelt es sich um eine bequeme Technik für die 
schnelle Aufnahme von mehreren Takes eines 
Parts, ohne dabei an Spontaneität einzubüßen.

Wenn Sie eine Loop-Aufnahme durchführen 
möchten, müssen Sie die Start- und Endpunkte des 
Loops angeben. Obwohl es verschiedene 
Möglichkeiten zum Festlegen von Aufnahme- und 
Wiedergabebereichen gibt (siehe „Festlegen der 
Punch- und Loop-Punkte“ auf Seite 459), ist die 
einfachste Möglichkeit, den zu loopenden Bereich 
in der Playlist der Spur zu selektieren (wobei 
Options > Link Timeline and Edit Selection 
aktiviert sein muss).

Die Pre-Roll-Einstellung kommt, falls aktiviert, 
nur während des ersten Aufnahmedurchgangs zur 
Anwendung. Bei allen nachfolgenden Loops 
werden die Pre- und Post-Roll-Zeiten ignoriert. 
Um dies auszugleichen, können Sie die Loop-
Bereiche leicht verlängern. Die aufgenommenen 
Takes können zu einem späteren Zeitpunkt mit 
dem Trim-Tool wieder auf die korrekte Länge 
zugeschnitten werden (siehe „Verwenden des 
Trim-Tools“ auf Seite 558).

Bei der Loop-Aufnahme von Audiomaterial 
erstellt Pro Tools eine einzige Audiodatei, in der 
sämtliche Takes enthalten sind. Takes erscheinen 
in der Clipliste als einzelne Clips und sind 
fortlaufend nummeriert. Nach Beendigung der 
Aufnahme können Sie alle aufgenommenen Takes 
abhören.

So führen Sie eine Loop-Aufnahme von 
Audiospuren durch:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Options > Loop Record. Beim 
Verwenden des Loop-Aufnahmemodus wird auf 
der Record-Schaltfläche das Symbol einer 
Schleife angezeigt.

• Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Record-Schaltfläche 
und wählen Sie Loop.

2 Schalten Sie die Audiospur scharf, indem Sie 
auf die entsprechende Record Enable-
Schaltfläche klicken.

3 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

Weitere Informationen zu Playlists und zum 
Bearbeiten von Playlists finden Sie unter 
„Playlists“ auf Seite 645.

Um alternative Takes, die im Loop-
Aufnahmemodus erstellt wurden, in 
anderen Sessions zu verwenden (etwa bei 
Verwendung von „Import Session Data“), 
müssen Sie Clipdefinitionen exportieren 
(siehe „Exportieren von Clipdefinitionen“ 
auf Seite 342). Werden keine 
Clipdefinitionen exportiert, sind im Loop-
Aufnahmemodus erstellte alternative 
Takes beim Import in andere Sessions 
nicht mehr zugänglich. 

Loop-Aufnahme aktiviert
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4 Selektieren Sie mit dem Selector-Tool den 
Loop-Bereich auf der Spur. Weitere Methoden 
zum Festlegen des Aufnahmebereichs finden 
Sie unter „Festlegen der Punch- und Loop-
Punkte“ auf Seite 459.

5 Um Spurmaterial bis zum Startpunkt des Loops 
abhören zu können, aktivieren Sie die Pre-Roll-
Funktion und legen Sie die Pre-Roll-Zeit fest 
(siehe „Einstellen von Pre- und Post-Roll“ auf 
Seite 463).

6 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

7 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

Während des Pre-Roll blinkt die Record-
Schaltfläche. Wenn der Startpunkt erreicht ist, 
beginnt Pro Tools mit der Aufnahme. Wenn der 
Endpunkt erreicht ist, loopt Pro Tools zurück zur 
Startzeit und fährt mit der Aufnahme fort.

8 Um während der Loop-Aufnahme alle 
aufgenommenen Takes abzubrechen, drücken 
Sie Befehl + Punkt (.) (Mac) bzw. Strg + Punkt 
(.) (Windows).

9 Klicken Sie abschließend auf „Stop“, um die 
Aufnahme anzuhalten.

Wenn Sie die Aufnahme anhalten, bevor die Hälfte 
des Loops erreicht ist, wird der betreffende Take 
verworfen. Wenn Sie mehr als die Hälfte des 
geloopten Takes aufnehmen, wird der Take nach 
dem Anhalten der Aufnahme in der Spur 
beibehalten.

Die aufgenommenen Takes erscheinen in 
der Clipliste als Clips und sind fortlaufend 
nummeriert. Der zuletzt aufgenommene Take wird 
in der aktiven Playlist auf der Spur angezeigt. 
Ausführliche Informationen zum Abhören der 
verschiedenen Takes finden Sie unter „Selektieren 
alternativer Takes“ auf Seite 472.

„Loop Playback“ und Audioaufnahme

Bei der Aufnahme in Pro Tools ist die Loop 

Playback-Funktion nicht wirksam. Die einzige 
Möglichkeit, während der Aufnahme mit Loops 
zu arbeiten, besteht in der Aktivierung des Loop-
Aufnahmemodus.

Automatically Create New 
Playlists When Loop Recording
Bei der Loop-Aufnahme erstellt Pro Tools 
automatisch eine einzelne Datei, in der alle 
Aufnahmedurchgänge enthalten sind. Jeder 
Aufnahmedurchgang ist ein eigener Clip in der 
Datei. Auf der Spur wird nur der letzte 
Aufnahmedurchgang als Clip in der Haupt-Playlist 
angezeigt. Alle anderen Clips 
(Aufnahmedurchgänge) werden ausgeblendet und 
können nur als übereinstimmende alternative Clips 
(Takes) wieder aufgerufen werden. Wenn die neue 
Option Automatically Create New Playlists When 

Loop Recording auf der Operation Preferences-
Registerkarte aktiviert ist, wird automatisch jeder 
Clip (Take) in eine neue Playlist der Spur kopiert. 
Dies erleichtert die Nutzung der Playlists-
Darstellung zum Abhören und Auswählen 
alternativer Takes.

So erstellen Sie automatisch neue Playlists bei der 
Loop-Aufnahme:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Aktivieren Sie im Recording-Bereich die 
Option Automatically Create New Playlists 

When Loop Recording.
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Alternative Takes
Bei der Punch- oder Loop-Aufnahme erstellt 
Pro Tools mehrere übereinstimmende alternative 
Takes (Clips). Mit Pro Tools können Sie Clips in 
der Haupt-Playlist auf einer Spur mit 
übereinstimmenden alternativen Clips aus anderen 
Playlists derselben Spur, von anderen Spuren oder 
aus der Clipliste austauschen. Übereinstimmende 
alternative Clips sind Clips, die bestimmte 
Kriterien erfüllen, etwa gelten Clips mit 
demselben User Time Stamp-Wert als 
übereinstimmend (siehe „Übereinstimmende 
alternative Clips“ auf Seite 656).

Selektieren alternativer Takes
Wenn Sie mehrere Takes mit einer Loop- oder 
Punch-Aufnahme aufgezeichnet haben, können 
Sie den Take, der sich gegenwärtig in der aktiven 
Playlist der Spur befindet, durch beliebige 
vorherige Takes ersetzen. Alle Takes sind 
fortlaufend nummeriert. 

Auswählen alternativer Takes aus 
der Clipliste

So wählen Sie einen Take aus der Clipliste aus:

1 Selektieren Sie im Edit-Fenster mit dem Time 
Grabber-Tool den aktuellen Clip (Take).

2 Halten Sie die Wahltaste (Mac) bzw. die Alt-
Taste (Windows) gedrückt und klicken Sie in 
der Clipliste auf die unterschiedlichen Clips, 
um diese abzuhören.

3 Ziehen Sie den gewünschten Clip bei 
gedrückter Ctrl-Taste (Mac) oder Windows-
Taste (Windows) von der Clipliste in die 
Playlist.

Der Clip ersetzt den vorherigen Take und wird 
genau an der richtigen Position eingefügt.

Selektieren alternativer Takes auf 
einer Spur

Alle Clips, die aus demselben Punch- oder Loop-
Aufnahmedurchgang stammen, haben eine 
identische Startzeit (den User Time Stamp-Wert). 
Sie können alternative Takes über das 
Kontextuntermenü „Matches“ oder das Popup-
Menü „Alternate Takes“ auswählen und abhören – 
sogar während der Wiedergabe. 

So selektieren Sie einen alternativen Take:

1 Stellen Sie sicher, dass die Spur-ID (oder der 
Spurname) ausgewählt wurde und dass im 
Matching Criteria-Fenster „Clip Start“ aktiviert 
ist (siehe „Matching Criteria-Fenster“ auf 
Seite 474).

2 Sie haben folgende Möglichkeiten:

• Wählen Sie das Selector- oder Grabber-Tool und 
klicken Sie mit der rechten Maustaste auf den Clip. 
Wählen Sie aus dem Matches-Untermenü des 
Popup-Menüs einen übereinstimmenden 
alternativen Take aus.

Matches-Kontextuntermenü
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• Wenn der gerade in der Spur befindliche Take 
selektiert ist, halten Sie die Befehlstaste (Mac) 
bzw. die Strg-Taste (Windows) gedrückt und 
klicken Sie mit dem Selector-Tool auf eine 
beliebige Stelle des selektierten Takes. Nun 
können Sie einen anderen Take aus dem Popup-
Menü „Alternate Takes“ wählen.

• Halten Sie bei Verwendung des Selector-Tools 
die Befehlstaste (Mac) bzw. die Strg-Taste 
(Windows) gedrückt und klicken Sie am genauen 
Anfang des Loop- oder Punch-Bereichs. Nun 
können Sie einen anderen Take aus dem Popup-
Menü „Alternate Takes“ wählen.

Der selektierte übereinstimmende alternative Clip 
(Take) ersetzt den Clip in der Haupt-Playlist und 
wird genau an der richtigen Position ausgerichtet.

Um sicherzustellen, dass nachfolgende Aufnahme-
Takes über den gleichen User Time Stamp-Wert 
verfügen (und damit als übereinstimmende 
alternative Clips verfügbar sind), speichern Sie die 
Punch- und Loop-Aufnahmeselektion als Memory 
Location. Wenn Sie später zusätzliche Takes 
aufnehmen möchten, rufen Sie die entsprechende 
Memory Location auf. 

Um den User Time Stamp-Wert anderer Clips zu 
ändern, sodass diese als alternative 
übereinstimmende Clips für eine bestimmte 
Position verfügbar gemacht werden, verwenden 
Sie den Time Stamp-Befehl im Cliplsiten-Menü. 

Übereinstimmungen und 
mehrere Spuren
Wenn Sie auf mehreren Spuren eine Loop-
Aufnahme erstellt haben und jede Spur mehrere 
Takes mit identischen User Time Stamp-Werten 
enthält, können Sie alle Takes gleichzeitig ändern.

So wechseln Sie Takes für mehrere Spuren:

1 Konfigurieren Sie das Matching Criteria-
Fenster (siehe „Matching Criteria-Fenster“ auf 
Seite 474), sodass folgende Optionen aktiviert 
sind:

• Track Name 

• Within Selection

2 Wählen Sie mit dem Selector-Tool den Take-
Bereich für die einzelnen zu ersetzenden Spuren 
aus.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste in die 
Edit-Selektion und wählen Sie einen anderen 
übereinstimmenden Alternativ-Take aus dem 
Matches-Untermenü.

• Klicken Sie bei gedrückter Befehlstaste (Mac) 
oder Strg-Taste (Windows) auf die Edit-
Selektion und wählen Sie im Popup-Menü 
„Alternates“ einen anderen Take aus.

Der ausgewählte Take ersetzt den vorherigen Take 
und wird genau an der richtigen Position in jeder 
Spur eingefügt.

Alternate Takes-Popup-Menü
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Matching Criteria-Fenster
Im Matching Criteria-Fenster können Sie die 
Übereinstimmungskriterien für alternative Clips 
auswählen. Sie können so die Liste verfügbarer 
übereinstimmender Clips im Popup-Menü 
„Alternate Takes“ und im Clips-Rechtsklick-
Untermenü „Matches“ (Übereinstimmungen) 
verfeinern.

Alternates Match-Optionen

Die folgenden Alternates Match-Optionen können 
in beliebiger Kombination ausgewählt werden.

Track ID – sämtliche auf derselben Spur 
aufgenommenen Clips werden als 
übereinstimmend angesehen. Verwenden Sie diese 
Option, um alternative Takes bei der Loop- oder 
Punch-Aufnahme auszuwählen.

Track Name – sämtliche Clips, die den gleichen 
Stammnamen haben wie die Spur oder Playlist, 
werden als übereinstimmend angesehen. So 
würden beispielsweise für eine Spur namens 
„Gtr.L“ die Clips „Gtr.L_01“ und „Gtr.L_02-01“, 
nicht aber „Guitar.L_01“ angezeigt. 

Clip Rating – sämtliche Clips mit derselben 
Bewertung werden als übereinstimmend 
angesehen. Aktivieren Sie diese Option, wenn Sie 
über bewertete Clips verfügen (siehe „Bewerten 
von Clips“ auf Seite 623). 

Übereinstimmungsoptionen unter „In Addition To“

Die folgenden Übereinstimmungsoptionen unter 
„In Addition To“ schließen sich gegenseitig aus.

All – sämtliche Clips, die die Zeitposition des Edit-
Cursors enthalten, oder sämtliche Clips, die 
teilweise oder ganz innerhalb des aktuellen 
Zeitbereichs der Edit-Selektion liegen.

Clip Start – sämtliche Clips, die über dieselbe 
Startzeit wie die Zeitposition des Edit-Cursors 
oder der Edit-Selektion verfügen.

Clip Start and End – sämtliche Clips, die über 
dieselben Start- und Endzeiten wie die Edit-
Selektion verfügen.

Within Selection – sämtliche vollständigen Clips, 
die komplett innerhalb der Edit-Selektion liegen.

None – es werden zusätzlich zu den ausgewählten 
Alternates Match-Optionen keine weiteren 
Kriterien zum Filtern übereinstimmender 
alternativer Clips verwendet.

Matching Criteria-Fenster

Sie können Übereinstimmungskriterien 
sowohl für MIDI- als auch Audioclips 
auswählen.
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Erweitern alternativer Takes auf 
neue Playlists oder Spuren
In Pro Tools können Sie alternative Takes in neue 
Playlists oder Spuren kopieren. Dies ist besonders 
hilfreich beim Abhören, Bearbeiten und Mischen 
mehrerer alternativer Takes oder Kanäle. 
Alternative Takes werden bei der Punch- und 
Loop-Aufnahme erstellt.

Erweitern alternativer Takes auf neue 
Playlists

Mit dem Erweitern alternativer Takes auf neue 
Playlists lässt sich das Spur-Compositing 
vereinfachen. Sobald Sie alternative Takes auf 
neue Playlists oder eine Spur erweitert haben, 
können Sie sie in der Playlists-Darstellung 
abhören und bearbeiten, um die besten Takes in 
der Haupt-Playlist zusammenzufassen.

So erweiten Sie alternative Takes auf neue 
Playlists:

1 Ermitteln Sie in der Haupt-Playlist den Clip mit 
übereinstimmenden alternativen Clips (Takes). 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste auf den 
Clip und wählen Sie Matches > Expand 

Alternates To New Playlists.

• Wenn der Clip bereits selektiert ist, verwenden 
Sie das Selector-Tool und klicken Sie bei 
gedrückter Befehlstaste (Mac) oder Strg-Taste 
(Windows) auf eine beliebige Stelle im 
selektierten Clip. Wählen Sie dann Matches > 

Expand Alternates To New Playlists.

• Wenn der Clip nicht selektiert ist, verwenden Sie 
das Selector-Tool und klicken Sie bei gedrückter 
Befehlstaste (Mac) oder Strg-Taste (Windows) 
auf die genaue Anfangsposition des Loop- oder 
Punch-Bereichs. Wählen Sie dann Matches > 

Expand Alternates To New Playlists.

Sämtliche übereinstimmenden alternativen Clips 
werden in neue Playlists auf der Spur kopiert. Um 
alle Playlists der Spur anzuzeigen, wählen Sie die 
Playlists-Darstellung. Sie können auch in einer 
beliebigen Spurdarstellung über den Playlist-
Selektor eine verfügbare alternative Playlist als 
Haupt-Playlist auswählen. Weitere Informationen 
finden Sie unter „Playlists-Darstellung“ auf 
Seite 651.

Erweitern alternativer Takes auf 
neue Spuren

Durch Erweitern alternativer Takes auf neue 
Spuren wird das Abhören, Bearbeiten und 
Mischen alternativer Takes auf verschiedenen 
Spuren erleichtert.

So erweiten Sie alternative Takes auf neue Spuren:

1 Ermitteln Sie in der Haupt-Playlist den Clip mit 
übereinstimmenden alternativen Clips (Takes). 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste auf den 
Clip und wählen Sie Matches > Expand 

Alternates To New Tracks.

• Wenn der Clip bereits selektiert ist, verwenden 
Sie das Selector-Tool und klicken Sie bei 
gedrückter Befehlstaste (Mac) oder Strg-Taste 
(Windows) auf eine beliebige Stelle im 
selektierten Clip. Wählen Sie dann Matches > 

Expand Alternates To New Tracks.

• Wenn der Clip nicht selektiert ist, verwenden Sie 
das Selector-Tool und klicken Sie bei gedrückter 
Befehlstaste (Mac) oder Strg-Taste (Windows) 
auf die genaue Anfangsposition des Loop- oder 
Punch-Bereichs. Wählen Sie dann Matches > 

Expand Alternates To New Tracks.

3 Wählen Sie dann eine der folgenden Optionen 
aus dem Untermenü „Expand Alternates To 
New Tracks“:
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By Track Name – benennt alle neuen Spuren nach 
dem Namen der Ausgangsspur.

By Clip Name – benennt alle neuen Spuren nach 
den Namen der jeweiligen ursprünglichen Clips, 
die in der Matches-Liste angezeigt werden.

By Track and Clip Name – benennt alle neuen 
Spuren nach dem Namen der Ausgangsspur und 
fügt die Namen der jeweiligen ursprünglichen 
Clips in Klammern hinzu.

Sämtliche übereinstimmenden alternativen Clips 
werden in neue Spuren kopiert.

Aufnehmen aus einer 
digitalen Quelle
Wenn Sie einen DAT-Rekorder, einen digitalen 
CD-Player oder ein anderes digitales Gerät mit 
Ihrem Pro Tools-System verwenden möchten, 
stellen Sie sicher, dass das richtige digitale 
Signalformat unterstützt wird. Beispielsweise 
sollten die AES/EBU-Ein- und Ausgänge an Ihrem 
Pro Tools-Audio-Interface nur mit anderen 
AES/EBU-Geräten verkabelt werden.

Digital-Optionen für Avid HD-
Audio-Interfaces
HD I/O und HD OMNI verfügen über Digital-
Optionen für AES/EBU, S/PDIF und ADAT. 
Zusätzlich dazu bietet HD I/O mit Digital-
Erweiterungskarte Optionen für TDIF Digital I/O.

HD MADI bietet sowohl Glasfaser- als auch 
Koaxial-MADI-Anschlüsse. (Weitere 
Informationen finden Sie im HD MADI-
Handbuch.) 

Mit einem HD I/O und HD OMNI kann Pro Tools 
jederzeit digitales Audiomaterial von dem 
werkseitig installierten Optical (ADAT) I/O 
empfangen (falls es nicht auf S/PDIF eingestellt 
ist). Pro Tools kann digitales Audio jedoch nur von 
jeweils einer der an die Enclosure-Ports [Encl] 
angeschlossenen Signalquellen (AES/EBU, 
S/PDIF oder Optical (S/PDIF)) empfangen.

Die digitalen Signalquellen für die Enclosure-Ports 
gehören zur Standardausstattung der Avid HD-
Audio-Interfaces und werden auf dem Bildschirm 
mit „[Encl]“ (Enclosure) als Gehäuse-Versionen 
gekennzeichnet, um sie von den digitalen Ein- und 
Ausgängen der Digital I/O-Karte des HD I/O zu 
unterscheiden. Beispiel: Die standardmäßigen 
AES/EBU-Eingänge und -Ausgänge des HD I/O-
Gehäuses haben die Bezeichnung „AES/EBU 
[Encl]“.

Die übrigen digitalen Ports des HD I/O sind TDIF-, 
AES/EBU- und ADAT-Anschlüsse. Von diesen 
Anschlüssen kann Pro Tools immer nur jeweils 
einen zum Empfang digitaler Audiosignale nutzen.

Die Eingänge am Gehäuse von HD I/O auf der 
dazugehörigen Digitalkarte können gleichzeitig 
verwendet werden. So kann beispielsweise beim 
HD I/O ein Eingang am Gehäuse als Taktgeber 
verwendet werden, während gleichzeitig an einem 
der Eingänge über die digitalen Anschlüsse eine 
Samplerate-Konvertierung durchgeführt wird. Es 
werden also zwei digitale Quellen gleichzeitig 
genutzt.

Weitere Informationen zum Konfigurieren 
Ihres Pro Tools-Systems für die Aufnahme 
aus einer digitalen Quelle finden Sie im 
Benutzerhandbuch.
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Digital-Optionen für Pro Tools-
Audio-Interfaces
003, 003 Rack und 003 Rack+ bieten 
Digitalanschlüsse für S/PDIF und ADAT. 

Eleven Rack bietet Digital-I/O für S/PDIF und 
AES/EBU.

Mbox (3. Generation), Mbox 2, Mbox Pro und 
Mbox Pro 2 verfügen nur über eine digitale Option 
für S/PDIF.

Die digitalen Ausgänge sind durchgängig aktiv. 
Sie können also beim Mischen digitales 
Audiomaterial gleichzeitig an verschiedene 
digitale Geräte senden. 

Aufnehmen aus digitalen Quellen

So nehmen Sie mit Pro Tools aus einer digitalen 
Quelle auf:

1 Verbinden Sie den Digitalausgang der 
Aufnahmequelle mit dem entsprechenden 
Digitaleingang Ihrer Audio-Hardware.

2 Wenn Sie eine neue Session mit einer anderen 
Samplerate starten möchten, gehen Sie wie 
folgt vor:

• Wählen Sie File > New Session.

• Wählen Sie die Samplerate aus.

• Konfigurieren Sie den Rest des Dialogfelds 
„New Session“ entsprechend.

• Klicken Sie auf Save.

3 Legen Sie das Format (digital) der Eingänge für 
das Audio-Interface fest, mit denen die digitale 
Aufnahmequelle verbunden ist. 

• Wählen Sie Setup > Hardware.

• Wählen Sie das Audio-Interface.

• Wählen Sie das digitale Format für das passende 
Kanalpaar (etwa AES/EBU oder S/PDIF). 

4 Wählen Sie bei Pro Tools HD im Session 
Setup-Fenster oder im Hardware Setup-
Dialogfeld die passende Clock Source-Option.

5 Erstellen Sie eine neue Stereo-Audiospur.

6 Weisen Sie mithilfe des Input Path-Selektors 
den gewünschten Eingang für die Spur zu. Da 
es sich um eine rein digitale Übertragung 
handelt, müssen Sie sich um die Aussteuerung 
des Eingangssignals keine Gedanken machen.

7 Weisen Sie mithilfe des Output Path-Selektors 
den passenden Monitoring-Ausgang für die 
Spur zu (etwa A 1–2). 

8 Vergewissern Sie sich, dass Sie im Options-
Menü die folgenden Optionen deaktiviert 
haben: „Destructive Record“, „Loop Record“, 
„QuickPunch“, „TrackPunch“ und 
„DestructivePunch“.

9 Um mit der Aufnahme am Anfang der Session 
zu beginnen, klicken Sie im Transport-Fenster 
auf „Return to Zero“.

10 Schalten Sie die neue Audiospur scharf.

Bei manchen Pro Tools-Audio-Interfaces 
stehen nur zwei wahlweise auf analog oder 
digital schaltbare Kanäle zur Verfügung. Bei 
Mbox (3. Generation) sind dies 
beispielsweise digitale S/PDIF-Eingänge für 
L und R (Stereo) und analoge Eingänge 
(In 1–2). Mbox (3. Generation) kann über 
analoge und digitale Eingänge gleichzeitig 
aufnehmen. 
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11 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

12 Klicken Sie auf „Play“, um die Aufnahme zu 
starten.

13 Starten Sie die Wiedergabe der 
Aufnahmequelle.

14 Wenn die Wiedergabe des Materials vom der 
Quelle beendet ist, klicken Sie im Transport-
Fenster auf „Stop“.

15 Beenden Sie die Wiedergabe der 
Aufnahmequelle.

Nach einer digitalen Übertragung
(Nur Avid HDX- und HD Native-Systeme)

Nach abgeschlossener digitaler Aufnahme wählen 
Sie im Clock Source-Popup-Menü im Session 
Setup-Fenster wieder die Option Internal. Dies ist 
wichtig, da Pro Tools ansonsten nicht auf den 
internen Taktgeber zurückschaltet und Aufnahme 
und Wiedergabe von Audiomaterial 
möglicherweise fehlerhaft durchführt. Sollten Sie 
es versäumen, auf „Internal Sync“ 
zurückzuschalten, hat das in der Regel Probleme 
mit der Tonhöhe (zu schnelle oder zu langsame 
Wiedergabe), Klick- und Knackgeräusche oder 
AAE-Fehlermeldungen zur Folge, da ein 
deaktivierter DAT- oder CD-Rekorder 
standardmäßig auf eine andere Samplerate 
umschalten oder die Ausgabe von 
Taktungssignalen für die Samplerate ganz beenden 
kann.

Aufnahme mit halber 
Geschwindigkeit
Mit Pro Tools können Sie mit halber 
Geschwindigkeit aufnehmen und wiedergeben. 
Diese Funktion ist vergleichbar mit der Aufnahme 
auf einer Bandmaschine, bei der Sie Material für 
Spezialeffekte mit halber Geschwindigkeit 
aufnehmen und anschließend 
in Normalgeschwindigkeit (schneller und eine 
Oktave höher) abspielen können oder Material in 
Normalgeschwindigkeit aufnehmen und mit 
halber Geschwindigkeit (langsamer und eine 
Oktave tiefer) abspielen können.

Benutzen Sie diese Funktion, wenn Sie schwierige 
Passagen auf MIDI-Spuren oder komplexe 
Automationsbewegungen aufnehmen möchten. 

So nehmen Sie mit halber Geschwindigkeit auf:

1 Schalten Sie die Spuren scharf, auf die mit 
halber Geschwindigkeit aufgenommen werden 
soll.

2 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

3 Drücken Sie Befehl + Umschalt + Leer (Mac) 
bzw. Strg + Umschalt + Leer (Windows). Die 
Aufnahme startet und das gesamte Spurmaterial 
wird mit halber Geschwindigkeit abgespielt.

4 Wenn Sie mit der Aufnahme fertig sind, klicken 
Sie auf „Stop“.

Weitere Informationen zur Wiedergabe mit 
halber Geschwindigkeit finden Sie unter 
„Wiedergabe mit halber Geschwindigkeit“ 
auf Seite 418.
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Kapitel 22: MIDI-Aufnahme

Obwohl die Aufnahme von MIDI in Pro Tools der 
Aufnahme von Audiomaterial ähnelt, gibt es doch 
einige entscheidende Unterschiede.

 Im Gegensatz zur Audioaufnahme ist die MIDI-
Aufnahme so gut wie immer destruktiv. Weitere 
Hinweise finden Sie unter „Aufnahmemodi und 
MIDI“ auf Seite 439.

 MIDI- und Instrumentenspuren können im 
Unterschied zu Audiospuren während der Aufnahme 
oder Wiedergabe scharfgeschaltet werden.

 Für MIDI- und Instrumentenspuren steht ein Input-
Selektor zur Verfügung, in dem festgelegt wird, 
welche Ports des MIDI-Interface und welcher MIDI-
Kanal auf die Spur geroutet und aufgenommen 
werden. Wenn der MIDI Input-Selektor auf „All“ 
eingestellt ist, werden alle Kanäle für sämtliche Geräte 
auf die Spur geroutet. 

 Für Instrumentenspuren stehen ähnlich wie bei 
Auxiliary-Eingängen Selektoren für Audioein- 
und -ausgänge zur Verfügung. Diese Selektoren 
unterscheiden sich von den Selektoren der 
Instrumentenspur für MIDI-Ein- und -Ausgänge 
und werden vornehmlich dazu verwendet, Audio 
von MIDI-Instrumenten oder Instrumenten-Plug-
Ins abzuhören. 

 Bei MIDI- und Instrumentenspuren ist es nicht 
notwendig, zur Durchführung einer Punch-In-
Aufnahme QuickPunch, TrackPunch oder 
DestructivePunch zu verwenden. Diese Funktion 
steht sowohl im Aufnahmemodus „Normal 
(Nondestructive)“ als auch im Aufnahmemodus 
„Destructive“ zur Verfügung.

Aufnehmen aus MIDI-Geräten
Die MIDI-Eingänge für die scharfgeschalteten 
MIDI- und Instrumentenspuren legen fest, welche 
MIDI-Daten in Pro Tools aufgenommen werden. 
MIDI-Eingänge können auf ein bestimmtes Gerät 
(Port) und einen spezifischen Kanal oder auf „All“ 
eingestellt werden. Bei der Einstellung „All“ 
werden alle Kanäle sämtlicher Geräte auf der Spur 
zusammengeführt.

MIDI- und Instrumentenspuren in Pro Tools 
können sich nicht aus mehreren Kanälen 
zusammensetzen. Die Wiedergabe erfolgt stets auf 
dem der Spur zugewiesenen MIDI-Ausgabegerät 
und dem entsprechenden Kanal. Mehrere MIDI-
Geräte und -Kanäle können jedoch gleichzeitig auf 
mehrere Spuren aufgezeichnet werden.

Die folgenden Pro Tools-Optionen bestimmen, 
ob von einem MIDI-Controller (wie einem MIDI-
Keyboard oder einem Drum-Pad) aus 
aufgezeichnet werden kann:

 Geräte, die im Peripherals-Dialogfeld (Setup > 

Peripherals) als MIDI-Controller eingerichtet 
sind, werden bei der Aufnahme von MIDI-Spuren 
ignoriert. Dadurch wird vermieden, dass Daten von 
MIDI-Bedienoberflächen (wie etwa Command|8) 
aufgezeichnet werden.

 Zum Aufnehmen und Wiedergeben von MIDI-
Daten muss das Gerät im MIDI Input Enable-
Dialogfeld aktiviert werden. Weitere 
Informationen finden Sie unter „Aktivieren von 
Eingabegeräten“ auf Seite 480.
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Darüber hinaus wirken sich die folgenden 
Optionen auf die Aufzeichnung von MIDI-Daten 
in Pro Tools aus:

 Mit dem MIDI-Eingangsfilter (Input Filter) 
können Sie MIDI-Daten herausfiltern, die nicht 
aufgezeichnet werden sollen (etwa Polyphonic 
Aftertouch oder System Exclusive-Daten). 
Weitere Informationen finden Sie unter „MIDI-
Eingangsfilter“ auf Seite 482.

 Wenn die Input Quantize-Option aktiviert ist, 
werden automatisch alle aufgenommenen MIDI-
Noten quantisiert (mit Zeitkorrektur versehen). 
Weitere Informationen finden Sie unter „Input 
Quantize“ auf Seite 482.

Aktivieren von 
Eingabegeräten
Um in Pro Tools von einem MIDI-Gerät (etwa 
einem MIDI-Keyboard) aufnehmen zu können, 
muss das Gerät im MIDI Input Enable-Dialogfeld 
aktiviert werden. In diesem Dialogfeld können Sie 
auch festlegen, dass unerwünschte Noten 
bestimmter Geräte (wie etwa Drum Machines und 
Arpeggiatoren) nicht aufgenommen werden.

MIDI-Bedienoberflächen – zur Verwendung von 
MIDI-Bedienoberflächen, wie etwa Command|8, 
müssen diese im MIDI Input Enable-Dialogfeld 
aktiviert werden.

MMC – damit sich Pro Tools mit MMC (MIDI-
Maschinensteuerung) synchronisieren kann, muss 
die MMC-Quelle im MIDI Input Enable-
Dialogfeld aktiviert werden. Weitere 
Informationen zum Verwenden von MMC mit 
Pro Tools finden Sie unter „MIDI-
Maschinensteuerung“ auf Seite 1218.

So aktivieren Sie Eingabegeräte:

1 Wählen Sie Setup > MIDI > Input Devices.

2 Wählen Sie das gewünschte MIDI-Gerät für die 
Aufzeichnung. Wählen Sie außerdem ein 
beliebiges Gerät als Bedienoberfläche.

3 Deaktivieren Sie alle Eingabegeräte, die während 
der MIDI-Aufnahme ignoriert werden sollen.

4 Klicken Sie auf OK.

MIDI Input Enable-Dialogfeld

Geräte müssen nicht ausgewählt sein, 
um MIDI-Daten von Pro Tools empfangen 
zu können. So brauchen beispielsweise 
Geräte, die ausschließlich als Soundmodule 
verwendet werden, nicht im MIDI Input 
Enable-Dialogfeld ausgewählt zu sein.
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MIDI Thru
Um MIDI-Spuren während der Aufnahme 
abzuhören, aktivieren Sie „MIDI Thru“. Wenn 
diese Option aktiviert ist, routet Pro Tools MIDI-
Daten von Ihren Controllern auf das Gerät und die 
Kanäle, die der gerade scharfgeschalteten MIDI-
Spur zugewiesen sind.

So aktivieren Sie die MIDI Thru-Option:

 Wählen Sie Options > MIDI Thru.

Standard-Thru-Instrument
Zusätzlich zu jeder scharfgeschalteten MIDI-Spur 
können Sie MIDI-Daten auch auf das Standard-
Thru-Instrument routen. Damit sparen Sie sich die 
zusätzlichen Schritte, eine MIDI-Spur zu erstellen 
und scharfzuschalten, um ein bestimmtes MIDI-
Gerät oder einen bestimmten MIDI-Kanal abhören 
zu können.

Im Gegensatz zu MIDI-Spuren, die MIDI 
ausschließlich vom Gerät und Kanal empfangen, 
die ihrem MIDI Input-Selektor zugewiesen sind, 
werden alle eingehenden MIDI-Daten auf das 
Standard-Thru-Instrument geroutet.

Wenn das Standard-Thru-Instrument einer 
scharfgeschalteten MIDI-Spur zugewiesen wurde, 
routet Pro Tools eingehende MIDI-Daten 
ausschließlich auf diese scharfgeschaltete Spur.

So konfigurieren Sie ein Standard-Thru-Instrument:

1 Wählen Sie Setup > Preferences. 

2 Klicken Sie auf die MIDI-Registerkarte. 

3 Sie haben folgende Möglichkeiten:

• Wählen Sie im Popup-Menü Default Thru 

Instrument ein bestimmtes Gerät aus, um MIDI 
standardmäßig auf diesem Gerät wiederzugeben. 

• Aktivieren Sie Follows First Selected MIDI 

Track, damit die MIDI-Vorschauzuweisung 
sich nach der MIDI-Spurenselektion richtet. 
Sind mehrere MIDI-Spuren selektiert, wird bei 
der Vorschau die oberste MIDI-Spur im Edit-
Fenster oder die ganz links stehende MIDI-Spur 
im Mix-Fenster verwendet. 

• Um die Funktion Default Thru Instrument 
zu deaktivieren, wählen Sie None.

Die MIDI-Voreinstellung „Global MIDI 
Playback Offset“ und die zeitliche 
Verschiebung der Wiedergabe einzelner 
MIDI-Spuren wirken sich nicht auf MIDI-
Daten aus, die mit der MIDI Thru-Option 
geroutet wurden.

Wenn die MIDI Thru-Option aktiviert ist, 
werden systemexklusive Events (Sysex) an 
das MIDI-Gerät weitergeleitet, das der 
scharfgeschalteten Spur zugewiesen ist. 
Voraussetzung dafür ist, dass die Größe 
der Sysex-Events 256 Byte nicht 
übersteigt.

Falls „Local Control“ auf Ihren MIDI-
Geräten vorhanden ist, sollte dies bei 
der Verwendung der MIDI Thru-Option 
deaktiviert sein. Andernfalls ist es möglich, 
dass Ihr Gerät MIDI-Noten doppelt empfängt 
und es zu so genannten Notenhängern kommt. 
Wenn Sie sich nicht sicher sind, wie Sie „Local 
Control“ für Ihr Instrument deaktivieren 
können, schlagen Sie in der dazugehörigen 
Dokumentation nach.

Wenn Sie die Option „Default Thru Follows 
First Selected MIDI Track Selection“ 
verwenden, können Sie das Instrument auch 
spielen, ohne eine MIDI- oder Instrumentenspur 
erstellen oder scharfschalten zu müssen.
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MIDI-Eingangsfilter
Verwenden Sie den MIDI-Eingangsfilter, um die 
Aufnahme von bestimmten MIDI-Befehlen 
zu verhindern. Der MIDI-Eingangsfilter kann 
so eingestellt werden, dass entweder alle Befehle 
(All), nur die angegebenen Befehle (Only) oder alle 
außer den angegebenen Befehlen (All except) 
aufgenommen werden.

So filtern Sie beispielsweise Program 
Changes heraus:

1 Wählen Sie Setup > MIDI > Input Filter.

2 Aktivieren Sie im MIDI Input Filter-Dialogfeld 
die All Except-Option.

3 Aktivieren Sie die Option für Program 
Changes. Lassen Sie alle anderen Befehle 
deaktiviert.

4 Klicken Sie auf OK.

Bei Verwendung der All Except-Option werden die 
ausgewählten Typen von MIDI-Befehlen nicht 
aufgezeichnet. Wenn Sie hingegen die Only-
Option aktivieren, werden nur die ausgewählten 
Typen von MIDI-Befehlen aufgezeichnet.

Input Quantize
Wenn Input Quantize im Input Quantize 
Event Operations-Dialogfeld aktiviert wurde 
(Event > Event Operations > Input Quantize), 
werden alle aufgezeichneten MIDI-Noten 
automatisch quantisiert. Das Quantisieren 
von MIDI bei der Eingabe ermöglicht rhythmisch 
präzise MIDI-Aufzeichnungen. Wenn jedoch alle 
ursprünglichen Nuancen der aufgezeichneten 
MIDI-Spuren beibehalten werden sollen 
(beispielsweise Rubato-Phrasing), sollte 
diese Option deaktiviert werden.

Auf Note warten
Mit der Wait for Note-Schaltfläche im Transport-
Fenster können Sie festlegen, wann Pro Tools mit 
der Aufnahme beginnen soll. Wenn diese Option 
aktiviert ist, beginnt die Aufnahme in Pro Tools erst 
bei Empfang eines MIDI-Events. Dadurch wird 
gewährleistet, dass die Aufnahme beginnt, wenn Sie 
zu spielen beginnen. Die erste Note (oder andere 
MIDI-Daten) werden dann genau am Anfang des 
festgelegten Aufnahmebereichs (Startzeit) 
aufgenommen.

Die Wait for Note-Option kann für normale 
Aufnahmen, für ein Punch-In oder auch für Loop-
Aufnahmen verwendet werden. Bei aktiviertem 
Pre-Roll wird dieses zwischen dem Empfang eines 
MIDI-Events und der Aufnahme ausgeführt.

MIDI Input Filter-Dialogfeld

Weitere Informationen zu „Input Quantize“ 
finden Sie unter „Input Quantize“ auf 
Seite 961. 

„Wait for Note“ und „Countoff“ schließen 
sich gegenseitig aus und können daher nicht 
gleichzeitig aktiviert werden. Wenn etwa 
„Countoff“ aktiviert ist und Sie auf die Wait 
for Note-Schaltfläche klicken, wird 
„Countoff“ deaktiviert. Zudem startet die 
Aufnahme bei „Wait for Note“ sofort, wobei 
eventuelle Pre-Rolls ignoriert werden.
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So aktivieren Sie die Wait for Note-Option:

1 Um die MIDI-Steuerelemente im Transport-
Fenster anzuzeigen, wählen Sie View > 

Transport > MIDI Controls.

2 Klicken Sie im Transport-Fenster auf die Wait 
for Note-Schaltfläche, um sie zu aktivieren.

MIDI Merge/Replace
Die MIDI Merge-Schaltfläche im Transport-Fenster 
bestimmt, wie MIDI-Daten beim Overdubbing oder 
bei Punch-In-Aufnahmen aufgezeichnet werden. 
Wenn „MIDI Merge“ aktiviert ist (Merge-Modus), 
werden neu aufgenommene MIDI-Daten mit dem 
bereits bestehenden Spurmaterial zusammengeführt. 
Ist „MIDI Merge“ deaktiviert (Replace-Modus), 
werden bestehende Daten innerhalb des Punch-Clips 
durch das neu aufgenommene Material ersetzt.

Die MIDI Merge-Schaltfläche kann während 
der Wiedergabe und Aufzeichnung aktiviert bzw. 
deaktiviert werden. Im Loop-Aufnahmemodus ist 
der MIDI Merge-Modus nicht wirksam und die 
betreffende Schaltfläche abgeblendet.

So aktivieren Sie die MIDI Merge-Option:

1 Um die MIDI-Steuerelemente im Transport-
Fenster anzuzeigen, wählen Sie View > 
Transport > MIDI Controls.

2 Klicken Sie im Transport-Fenster auf die MIDI 
Merge-Schaltfläche, um sie zu aktivieren.

Transport-Fenster mit MIDI-Steuerelementen

Wait for Note-Schaltfläche aktiviert

Wenn die Operation-Voreinstellung „Use 
F11 for Wait for Note“ aktiviert ist, können 
Sie die Wait for Note-Option mit F11 
aktivieren. (Bei Mac-Systemen muss die 
Mac-Tastenkombination „Desktop“ 
deaktiviert oder neu zugewiesen werden.)

Um MIDI Merge durch Drücken einer 
Tastenkombination zu aktivieren, 
versetzen Sie den Ziffernblock in den 
Transport-Modus und drücken auf dem 
Ziffernblock die 9. 

MIDI-Noten können auch mithilfe der 
Paste Special-Befehle eingefügt und 
zusammengeführt werden. Siehe „Special 
Paste-Funktion für Automationsdaten“ auf 
Seite 1109.

MIDI Merge-Schaltfläche aktiviert
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Konfigurieren von MIDI- oder 
Instrumentenspuren für die 
Aufnahme
So konfigurieren Sie eine oder mehrere MIDI- oder 
Instrumentenspuren für die Aufnahme:

1 Erstellen Sie eine neue MIDI- oder 
Instrumentenspur oder verwenden Sie eine 
bestehende MIDI- oder Instrumentenspur.

2 Wählen Sie für Instrumentenspuren View > Mix 

Window > Instruments oder View > Edit 

Window > Instruments.

3 Wählen Sie im MIDI Input-Selektor der Spur 
das Gerät und den Kanal für die Aufzeichnung 
aus. (Bei Instrumentenspuren befindet sich der 
MIDI Input-Selektor im Instruments-
Bedienfeld.)

4 Wählen Sie im MIDI Output-Selektor das Gerät 
und den Kanal für die MIDI-Wiedergabe aus.

5 Wenn Sie einer MIDI- oder Instrumentenspur 
mehrere Ziele zuweisen möchten, klicken 
Sie bei gedrückter Ctrl-Taste (Mac) oder 
Windows-Taste (Windows) auf den MIDI 
Output-Selektor und wählen Sie weitere Kanäle 
für die gewünschten Geräte. Wenn für eine 
einzige MIDI-Spur mehrere Ziele ausgewählt 
sind, wird neben dem Namen des ersten Ziels 
im MIDI Output-Selektor der Spur ein 
Pluszeichen („+“) angezeigt.

MIDI Input-Selektor für MIDI-Spuren

MIDI Input-Selektor für Instrumentenspuren

MIDI Output-Selektor für MIDI-Spuren

MIDI Input-Selektor für Instrumentenspuren
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6 Führen Sie folgende Aktionen aus, um der Spur 
einen Standard-Program Change zuzuweisen.

• Klicken Sie auf die Patch Select-Schaltfläche.

• Nehmen Sie die erforderliche Programm- und 
Bankauswahl vor.

• Klicken Sie auf Done.

7 Wiederholen Sie zur Aufzeichnung auf 
mehrere MIDI- oder Instrumentenspuren die 
beschriebenen Schritte für jede einzelne Spur 
und fahren Sie dann mit dem nächsten Schritt 
fort.

8 Zur Verwendung eines Metronoms aktivieren 
und konfigurieren Sie dieses und geben Sie 
Standardtempo und -taktart für die Session vor 
(siehe „Aufnehmen mit dem Metronom“ auf 
Seite 430).

9 Aktivieren Sie im Transport-Fenster „Wait for 
Note“ oder „Countoff“. 

10 Um bestehendes Spurmaterial zu ersetzen, 
deaktivieren Sie im Transport-Fenster die MIDI 
Merge-Option (siehe „MIDI Merge/Replace“ 
auf Seite 483).

11 Um das Material bei der Aufnahme automatisch 
zu quantisieren, aktivieren Sie Input Quantize 
(Event > Event Operations > Input Quantize). 
Siehe „Input Quantize“ auf Seite 482.

12 Um mit der Aufnahme am Anfang der Session 
zu beginnen, klicken Sie im Transport-Fenster 
auf „Return to Zero“.

13 Schalten Sie die MIDI- oder Instrumentenspur 
scharf, indem Sie auf die entsprechende Record 
Enable-Schaltfläche klicken.

14 Vergewissern Sie sich, dass Options > MIDI 

Thru aktiviert ist, und spielen Sie auf dem 
MIDI-Controller. Das den MIDI-
Ausgangstönen der Spur zugewiesene MIDI-
Gerät oder Instrumenten-Plug-In sollte hörbar 
sein und die Pegelanzeigen der Spur die MIDI-
Aktivität (Noten-Velocity) registrieren.

Sie können nun MIDI-Daten auf die 
scharfgeschalteten MIDI- und Instrumentenspuren 
aufnehmen.

Der Standard-Program Change wird bei der 
Wiedergabe der Spur gesendet. Weitere 
Informationen finden Sie unter „Patch 
Select-Dialogfeld (Program und Bank 
Changes)“ auf Seite 715.

Um weitere MIDI- und Instrumentenspuren 
scharfzuschalten, klicken Sie bei gedrückter 
Umschalttaste auf die dazugehörigen Record 
Enable-Schaltflächen.

Um Audio über ein externes MIDI-
Instrument abzuhören, wählen Sie den 
entsprechenden Audio-Eingangspfad für das 
MIDI-Instrument auf der Instrumentenspur. 
Sie können auch eine Auxiliary-Eingangs-
Spur verwenden. Siehe „Signal-Routing zum 
Abhören und Erstellen von Submixes“ auf 
Seite 1014.
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Aufzeichnen von MIDI- und 
Instrumentenspuren
Sie können in Pro Tools auf eine oder mehrere 
MIDI- und Instrumentenspuren aufnehmen. Die 
gleichzeitige Aufnahme auf mehrere Spuren bietet 
folgende Vorteile:

• gleichzeitiges Aufnehmen von mehreren MIDI-
Geräten, beispielsweise bei der Aufnahme 
verschiedener Interpreten

• Aufnehmen mehrerer Kanäle vom gleichen 
Gerät, beispielsweise bei der Aufnahme von 
einer geteilten Tastatur

• Übertragen von MIDI-Spuren von einem 
externen MIDI-Sequenzer

So nehmen Sie auf eine oder mehrere MIDI- oder 
Instrumentenspuren auf:

1 Konfigurieren Sie eine MIDI- oder 
Instrumentenspur für die Aufnahme (siehe 
„Konfigurieren von MIDI- oder 
Instrumentenspuren für die Aufnahme“ auf 
Seite 484).

2 Achten Sie darauf, dass die Spur, auf die Sie 
aufnehmen möchten, scharfgeschaltet ist.

3 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist 
(siehe „Aufnahmemodi“ auf Seite 436).

4 Klicken Sie im Transport-Fenster auf 
„Record“, um Pro Tools für die Aufnahme 
scharfzuschalten (Record Ready-Modus). 
Die Track Record Enabled-Anzeige leuchtet 
rot auf.

5 Sie haben folgende Möglichkeiten:

• Klicken Sie auf „Play“, um die Aufnahme zu 
starten. Wenn Sie einen Countoff benutzen, 
zählt Pro Tools die angegebene Anzahl an 
Einheiten vor und beginnt anschließend mit der 
Aufnahme. 

• Wenn „Wait for Note“ aktiviert ist, klicken Sie 
nicht auf die Schaltfläche „Play“. Die Aufnahme 
wird automatisch gestartet, wenn Sie zu spielen 
beginnen (wenn ein MIDI-Event empfangen 
wird).

Um die Möglichkeiten der MIDI-Bearbeitung 
in Pro Tools in vollem Umfang nutzen zu 
können, stellen Sie sicher, dass der 
Metronom-Klick während der Aufnahme von 
tickbasierten MIDI-Spuren aktiviert ist. 
Dadurch wird garantiert, dass sich die 
aufgenommenen Daten in das Taktschema 
der Session einfügen. Sie können stattdessen 
auch auf samplebasierte MIDI-Spuren 
aufnehmen und das Tempo und die Taktart 
aus dem aufgenommenen Material ableiten.

Um Audiomaterial aus einem MIDI-
Instrument oder Instrumenten-Plug-In 
aufzunehmen, leiten Sie den Audio-Output 
der Instrumenten- oder Auxiliary-Eingangs-
Spur, über die das Instrument abgehört wird, 
an eine Audiospur. Schalten Sie die 
Audiospur scharf und beginnen Sie mit der 
Aufnahme. Siehe „Aufnehmen von 
Audiomaterial von einem MIDI-Instrument“ 
auf Seite 495.

Um weitere MIDI- und Instrumentenspuren 
scharfzuschalten, klicken Sie bei gedrückter 
Umschalttaste auf die dazugehörigen Record 
Enable-Schaltflächen.

Record-Schaltfläche im Record Ready-Modus
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6 Spielen Sie auf Ihrem MIDI-Controller.

7 Wenn Sie fertig sind, klicken Sie im Transport-
Fenster auf „Stop“, um die Aufnahme 
anzuhalten.

Für jede scharfgeschaltete Spur wird ein neuer 
MIDI-Clip erstellt, die anschließend in der Playlist 
und in der Clipliste erscheint.

MIDI-Clips werden auf 
Taktstrichen erstellt.
Bei der MIDI-Aufnahme oder bei der manuellen 
Eingabe von MIDI-Noten werden der Anfang und 
das Ende der resultierenden MIDI-Clips auf 
Taktgrenzen erstellt. Dies ermöglicht die einfache 
Anordnung von MIDI-Clips auf musikalisch 
sinnvolle Art in ganzen Taktlängen.

Der Anfang eines aufgenommenen MIDI-Clips 
beginnt immer mit dem Taktstrich direkt vor der 
ersten MIDI-Note (Note On) des Clips. Der MIDI-
Clip endet auch mit dem Taktstrich direkt nach der 
letzten Note (Note Off) des Clips. 

Aufnahme über bestehende 
MIDI-Clips
Vorhandene MIDI-Clips werden im Gegensatz 
zu Audioclips nie überschrieben, auch wenn 
MIDI-Daten in den Clips überschrieben werden 
können. Wenn der MIDI Merge-Modus deaktiviert 
ist und die Aufnahme von MIDI auf eine Spur mit 
bestehenden Clips erfolgt, werden bestehende 
MIDI-Daten innerhalb bestehender Clips mit den 
neu aufgenommenen MIDI-Daten überschrieben. 

Die bestehenden Clipgrenzen bleiben jedoch 
bestehen. Neue MIDI-Clips werden nur erstellt, 
um die Lücken zwischen bestehenden MIDI-Clip-
Grenzen zu füllen. Neue MIDI-Clips werden 
normalerweise immer auf Taktstrichen erstellt. 
Wenn bestehende Clipgrenzen jedoch nicht auf 
Taktstrichen liegen, werden die neu erstellten 
Clips von den bestehenden Clips begrenzt.

Wiedergeben von 
aufgenommenen MIDI-Daten

So geben Sie aufgenommene MIDI- und 
Instrumentenspuren wieder:

1 Um am Anfang der Session zu beginnen, 
klicken Sie im Transport-Fenster auf „Return to 
Zero“.

2 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

Die aufgenommenen MIDI-Daten werden 
über das der jeweiligen Spur zugewiesene 
Ausgabegerät (Port) und den entsprechenden 
Kanal abgespielt.

Drücken Sie F12, um die Aufnahme sofort zu 
starten. Sie können auch Befehl + Leer 
(Mac) bzw. Strg + Leer (Windows) drücken, 
um die Aufnahme zu starten. Weitere 
Informationen finden Sie unter 
„Tastenkombinationen für die Aufnahme“ 
auf Seite 458.

Es kann vorkommen, dass der Note On-Punkt 
einer MIDI-Note in einem MIDI-Clip liegt, 
der Note Off-Punkt jedoch im folgenden 
MIDI-Clip. Ebenso ist es möglich, dass ein 
Clip vor dem Note Off-Punkt endet, sodass 
Noten über die Clipgrenze hinaus bestehen. 
Ein Note On-Punkt kann jedoch nie einem 
Clip vorangehen. 

Um Audio über ein externes MIDI-
Instrument abzuhören, wählen Sie den 
entsprechenden Audio-Eingangspfad für das 
MIDI-Instrument auf der Instrumentenspur. 
Sie können auch eine Auxiliary-Eingangs-
Spur verwenden. Siehe „Signal-Routing zum 
Abhören und Erstellen von Submixes“ auf 
Seite 1014.
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Rückgängigmachen von MIDI-
Aufnahmen
Vorherige MIDI-Aufnahme-Takes können 
rückgängig gemacht werden.

So machen Sie eine MIDI-Aufnahme rückgängig:

 Nachdem der Transport angehalten wurde, 
wählen Sie Edit > Undo MIDI Recording. 

Die Playlist der Spur wird in ihren ursprünglichen 
Zustand zurückversetzt. Dafür gelten jedoch 
folgende Bedingungen:

• Wenn Sie vor dem Anhalten des Transports 
einige Punch-In- und Punch-Out-Vorgänge 
durchgeführt haben, kann nur der letzte Punch 
rückgängig gemacht werden.

• Wenn Sie den Loop-Aufnahmemodus 
verwenden, werden alle Takes jedes 
Aufnahmedurchgangs entfernt.

Abbrechen eines Aufnahme-
Takes
Es ist auch möglich, den aktuellen Aufnahme-
Take zu verwerfen, bevor der Transport 
angehalten wird.

So brechen Sie einen Take während der 
Aufnahme ab:

 Drücken Sie Befehl + Punkt (.) (Mac) bzw. 
Strg + Punkt (.) (Windows), bevor der Transport 
angehalten wird.

Im Loop-Aufnahmemodus werden alle Takes 
jedes Aufnahmedurchgangs entfernt.

Punch-Aufnahme von MIDI-
Material über einen 
festgelegten Bereich
Sie können Pro Tools so konfigurieren, dass die 
Punch-Aufnahme automatisch über einen 
bestimmten Bereich in einer MIDI- oder 
Instrumentenspur erfolgt. Start- und Endpunkt des 
Bereichs (Punch-In und Punch-Out) müssen vor 
der Aufnahme festgelegt werden.

So führen Sie ein Punch-In auf einer MIDI- oder 
Instrumentenspur durch:

1 Konfigurieren Sie eine MIDI- oder 
Instrumentenspur für die Aufnahme 
(siehe „Konfigurieren von MIDI- oder 
Instrumentenspuren für die Aufnahme“ auf 
Seite 484).

2 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist (siehe 
„Aufnahmemodi“ auf Seite 436).

3 Deaktivieren Sie im Transport-Fenster die Wait 
for Note- und Countoff-Option.

4 Aktivieren Sie Options > Link Timeline and Edit 

Selection.

5 Selektieren Sie mit dem Selector-Tool den 
Punch-Bereich in der Playlist der Spur.

6 Um bestehendes Spurmaterial bis zum 
Startpunkt bzw. nach dem Endpunkt abhören zu 
können, stellen Sie Pre- und Post-Roll-Zeiten 
ein (siehe „Einstellen von Pre- und Post-Roll“ 
auf Seite 463).

7 Schalten Sie die Spur mit dem vorhergehenden 
Take scharf.

Weitere Methoden zum Festlegen des 
Aufnahmebereichs finden Sie unter 
„Festlegen der Punch- und Loop-Punkte“ 
auf Seite 459.
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8 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten. Die Record-Schaltfläche 
beginnt zu blinken.

9 Klicken Sie auf „Play“, um die Aufnahme zu 
starten.

Wenn Pre-Roll aktiviert ist, wird das Spurmaterial 
bis zum Punch-In-Punkt abgespielt. Um sich auf 
die Aufnahme einzustimmen, können Sie bereits 
während des Pre-Roll mit dem Spielen beginnen. 
Das MIDI-Material wird erst aufgezeichnet, 
nachdem der Startpunkt erreicht wurde.

Wenn der Startpunkt erreicht ist, beginnt 
Pro Tools mit der Aufnahme. Die Aufnahme wird 
fortgesetzt, bis der Endpunkt erreicht wird. Bei 
aktiviertem Post-Roll wird die Wiedergabe 
entsprechend der angegebenen Post-Roll-Dauer 
fortgesetzt.

10 Klicken Sie im Transport-Fenster auf „Stop“, 
wenn Sie mit der Aufnahme fertig sind. Die neu 
aufgenommenen MIDI-Daten werden auf der 
Spur angezeigt.

Punch-Aufnahme während der 
Wiedergabe mit MIDI
Sie müssen keinen Aufnahmebereich einstellen, 
um einen Punch-In-Vorgang auf einer MIDI- oder 
Instrumentenspur durchzuführen. Stattdessen 
können Sie während der Wiedergabe Punches 
ausführen. Im Gegensatz zu Audiospuren ist die 
Aktivierung von QuickPunch für eine Punch-
Aufnahme in Echtzeit bei MIDI nicht notwendig.

So führen Sie Punch-Aufnahmen mit MIDI durch:

1 Konfigurieren Sie eine MIDI- oder 
Instrumentenspur für die Aufnahme (siehe 
„Konfigurieren von MIDI- oder 
Instrumentenspuren für die Aufnahme“ auf 
Seite 484).

2 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist (siehe 
„Aufnahmemodi“ auf Seite 436).

3 Deaktivieren Sie im Transport-Fenster die Wait 
for Note- und Countoff-Option.

4 Schalten Sie die Spur mit dem vorhergehenden 
Take scharf.

5 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten. 

6 Wenn Sie den Punch-In-Punkt erreichen, haben 
Sie folgende Möglichkeiten:

• Klicken Sie im Transport-Fenster auf „Record“.

• Betätigen Sie bei Pro Tools-Systemen, die einen 
angeschlossenen Fußschalter unterstützen, bei 
Erreichen des Punch-In-Punkts den Fußschalter.

Die Record-Schaltfläche im Transport-Fenster und 
die Record Enable-Schaltfläche blinken nicht mehr 
und leuchten während der Aufnahme.

7 Um einen Punch-Out-Vorgang durchzuführen, 
klicken Sie erneut auf „Record“ (bzw. betätigen 
Sie den Fußschalter).

Pro Tools verlässt den Aufnahmemodus und fährt 
mit der Wiedergabe fort. Sie können während des 
gleichen Durchgangs weitere Punch-Vorgänge 
ausführen.

Fußschalter werden unterstützt von Interfaces 
der Reihe 003, Mbox Pro und Mbox 2 Pro 
sowie von allen Pro Tools-Systemen mit 
geeigneter Bedienoberfläche (beispielsweise 
C|24 oder Command|8).
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MIDI-Clips und Punch-Aufnahmen
Abhängig vom Aufnahmebereich werden nach der 
Punch-Aufnahme neue Clips erstellt. 

Wenn der MIDI Merge-Modus deaktiviert ist, 
werden beispielsweise alle eventuell bestehenden 
MIDI-Daten innerhalb des Aufnahmebereichs 
durch die Aufnahme überschrieben. Da sich 
die Start- und Endzeiten von Aufnahmen in beiden 
vorhandenen Clips befinden, werden neu 
aufgenommene Noten in beide vorhandene Clips 
geschrieben sowie in einen neu erstellten Clip, 
um die Lücke dazwischen zu füllen.

Wird vor der Punch-Aufnahme ein gesamter Clip 
oder ein Abschnitt innerhalb eines Clips selektiert, 
so werden keine neuen Clips erstellt. In diesem 
Fall ändert sich nur das Material innerhalb des 
vorhandenen Clips, ohne dass neues Material 
außerhalb des Clips aufgenommen wird.

Im Gegensatz zur Audioaufnahme ist die MIDI-
Aufnahme in dieser Situation destruktiv. 
Vorhandene MIDI-Daten werden mit neu 
aufgenommenen MIDI-Daten überschrieben. 
Die bestehenden Clipgrenzen bleiben bestehen.

Werden MIDI-Daten innerhalb eines Clips durch 
einen Aufnahme-Take geändert, geht das 
ursprüngliche Material entweder verloren (außer 
Sie wählen „Edit > Undo MIDI Recording“) oder 
es wird mit dem neuen Material zusammengefügt 
(wenn die MIDI Merge-Option während der 
Aufnahme aktiviert war). Wenn ein bestehender 
Clip Material enthält, das Sie behalten möchten, 
verwenden Sie den Duplicate-Befehl, um eine 
Kopie von dem Clip („Duplizieren von Clips“ auf 
Seite 870) oder von der Playlist der Spur zu 
erstellen, oder nehmen Sie es in einer neuen 
Playlist als Sicherungskopie auf (siehe „Arbeiten 
mit Playlists“ auf Seite 645).

Loop-Aufnahme von MIDI
Für Loop-Aufnahmen von MIDI stehen folgende 
zwei Methoden zur Verfügung: 

• Aktivieren Sie für Loop-Aufnahmen im Drum 
Machine-Stil im Aufnahmemodus „Normal 
(Nondestructive)“ die Loop Playback- und 
MIDI Merge-Optionen.

• Verwenden Sie den Loop-Aufnahmemodus, um 
in jedem Aufnahmedurchgang mehrere Takes 
aufzuzeichnen. Dies ist vergleichbar mit Loop-
Aufnahmen von Audiomaterial.

Nach der Punch-Aufnahme hinzugefügter Clip

Neuer ClipNeu aufgenommenes
Material

Vor Punch-Aufnahme

Nach Punch-Aufnahme
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Loop-Aufnahme im MIDI Merge-
Modus
Verwenden Sie für Loop-Aufnahmen von MIDI 
den Aufnahmemodus „Normal (Nondestructive)“ 
und aktivieren Sie die Loop Playback- und MIDI 
Merge-Optionen. Bei dieser Methode werden 
MIDI-Daten aufgenommen und bei jedem neuen 
Aufnahmedurchgang dem gleichen Clip 
hinzugefügt. So können Sie etwa beim ersten 
Durchgang die Hi-Hats und beim nächsten Kick 
und Snare einspielen.

Vergewissern Sie sich, dass „MIDI Merge“ im 
Transport-Fenster aktiviert ist, da ansonsten (im 
Replace-Modus) jeder neue Aufnahme-Take die 
jeweils vorherige Einspielung destruktiv ersetzt.

So führen Sie eine Loop-Aufnahme im MIDI Merge-
Modus durch:

1 Konfigurieren Sie eine MIDI- oder 
Instrumentenspur für die Aufnahme (siehe 
„Konfigurieren von MIDI- oder 
Instrumentenspuren für die Aufnahme“ auf 
Seite 484).

2 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist (siehe 
„Aufnahmemodi“ auf Seite 436).

3 Aktivieren Sie Options > Loop Playback. 
Wenn die Loop-Wiedergabe aktiviert ist, 
erscheint in der Play-Schaltfläche das Symbol 
einer Schleife.

4 Schalten Sie die MIDI- oder Instrumentenspur 
scharf. Stellen Sie sicher, dass keine 
Audiospuren scharfgeschaltet sind.

5 Klicken Sie im Transport-Fenster auf die MIDI 
Merge-Schaltfläche, um sie zu aktivieren.

6 Deaktivieren Sie im Transport-Fenster die Wait 
for Note- und Countoff-Optionen.

7 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

8 Selektieren Sie mit dem Selector-Tool den 
Loop-Bereich in der Playlist der Spur.

9 Um Spurmaterial bis zum Startpunkt des Loops 
abhören zu können, aktivieren Sie die Pre-Roll-
Funktion und legen Sie die Pre-Roll-Zeit fest 
(siehe „Einstellen von Pre- und Post-Roll“ auf 
Seite 463).

10 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten. Die Record-Schaltfläche 
beginnt zu blinken.

Verwenden Sie „Step Input“, um Material 
im Drum Machine-Stil schrittweise 
einzugeben (siehe „Step Input“ auf 
Seite 962).

Während der Loop-Aufnahme können Sie 
eine weitere MIDI- oder Instrumentenspur 
für die Aufnahme scharfschalten. Drücken 
Sie bei gedrückter Befehlstaste (Mac) oder 
Strg-Taste (Windows) den Nach-oben- bzw. 
den Nach-unten-Pfeil, um die vorherige 
bzw. nächste MIDI- oder Instrumentenspur 
scharfzuschalten.

Loop Playback-Option aktiviert

Weitere Methoden zum Festlegen des 
Aufnahmebereichs finden Sie unter „Festlegen 
der Punch- und Loop-Punkte“ auf Seite 459.
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11 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

Während des Pre-Roll blinkt die Record-
Schaltfläche. Wenn der Startpunkt erreicht ist, 
beginnt Pro Tools mit der Aufnahme. Wenn der 
Endpunkt erreicht ist, loopt Pro Tools zurück zum 
Startpunkt und fährt mit Wiedergabe und 
Aufnahme fort.

12 Spielen Sie auf Ihrem MIDI-Controller. Neu 
aufgenommene MIDI-Daten erscheinen in der 
Aufnahmespur als Clip. Bei jedem folgenden 
Take wird aufgenommenes Material im Clip 
angezeigt, wobei das Material aus vorherigen 
Takes nicht überschrieben wird.

13 Drücken Sie zum Wechseln auf eine neue 
Aufnahmespur bei gedrückter Befehlstaste 
(Mac) oder Strg-Taste (Windows) die 
Pfeiltasten nach oben bzw. unten. Dadurch wird 
die vorherige bzw. nächste MIDI- oder 
Instrumentenspur scharfgeschaltet.

14 Klicken Sie im Transport-Fenster auf „Stop“, 
wenn Sie mit der Aufnahme fertig sind.

Die neu aufgenommenen MIDI-Daten werden als 
MIDI-Clip in der Playlist der Spur angezeigt und 
in der Clipliste aufgeführt.

Loop-Aufnahme von 
mehreren Takes
Wenn MIDI-Daten im Loop-Aufnahmemodus 
aufgenommen werden, werden bei jedem 
Empfang von neuem Material während eines 
Aufnahmedurchgangs neue Clips erstellt. Dieser 
Vorgang unterscheidet sich leicht von der Loop-
Aufnahme von Audiomaterial, bei der Pro Tools 
eine einzelne Audiodatei mit allen Takes erstellt, 
die wiederum als einzelne Clips in der Clipliste 
angezeigt werden.

Diese Methode der MIDI-Loop-Aufnahme 
ermöglicht die Aufnahme von aufeinander 
folgenden Takes ohne Unterbrechung des 
Aufnahmevorgangs und bewahrt so Ihre kreative 
Spontaneität. Darüber hinaus bietet diese nicht 
destruktive Methode der MIDI-Aufnahme den 
Vorteil, dass bestehende und neu aufgenommene 
Clips intakt und in der Clipliste verfügbar bleiben.

So nehmen Sie MIDI-Daten im Loop-
Aufnahmemodus auf:

1 Konfigurieren Sie eine MIDI- oder 
Instrumentenspur für die Aufnahme (siehe 
„Konfigurieren von MIDI- oder 
Instrumentenspuren für die Aufnahme“ auf 
Seite 484).

2 Wählen Sie Options > Loop Record. Beim 
Verwenden des Loop-Aufnahmemodus wird 
auf der Record-Schaltfläche das Symbol einer 
Schleife angezeigt.

Loop-Aufnahme aktiviert
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3 Falls nicht schon geschehen, schalten Sie die 
MIDI- oder Instrumentenspur durch Klicken 
auf die entsprechende Record Enable-
Schaltfläche scharf. Stellen Sie sicher, dass 
keine Audiospuren scharfgeschaltet sind.

4 Deaktivieren Sie im Transport-Fenster die Wait 
for Note- und Countoff-Optionen.

5 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

6 Selektieren Sie mit dem Selector-Tool den 
Loop-Bereich in der Playlist der Spur.

7 Um Spurmaterial bis zum Startpunkt des Loops 
abhören zu können, aktivieren Sie die Pre-Roll-
Funktion und legen Sie die Pre-Roll-Zeit fest 
(siehe „Einstellen von Pre- und Post-Roll“ auf 
Seite 463).

8 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten. Die Record-Schaltfläche 
beginnt zu blinken.

9 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

Während des Pre-Roll blinkt die Record-
Schaltfläche. Wenn der Startpunkt erreicht ist, 
beginnt Pro Tools mit der Aufnahme. Wenn der 
Endpunkt erreicht ist, loopt Pro Tools zurück zum 
Startpunkt und fährt mit Wiedergabe und 
Aufnahme fort.

10 Spielen Sie auf Ihrem MIDI-Controller. Es wird 
automatisch ein neuer MIDI-Clip mit dem neu 
aufgenommenen Material erstellt, der in der 
Playlist der Spur angezeigt wird und den 
vorherigen Clip ersetzt.

Clips werden bei nachfolgenden 
Aufnahmedurchgängen (nicht destruktiv) ersetzt, 
wenn neues MIDI-Material empfangen wird.

11 Klicken Sie im Transport-Fenster auf „Stop“, 
wenn Sie mit der Aufnahme fertig sind.

Die aufgenommenen Takes erscheinen in der 
Clipliste als Clips und sind fortlaufend 
nummeriert. Die Takes, die gleich lang und 
einfach austauschbar sind, können im Matches-
Popup-Menü ausgewählt werden, selbst während 
die Session wiedergegeben oder geloopt wird.

So wählen Sie die verschiedenen Aufnahme-Takes 
aus:

1 Stellen Sie sicher, dass das Matching Criteria-
Fenster ordnungsgemäß konfiguriert ist (siehe 
„Matching Criteria-Fenster“ auf Seite 474).

2 Sie haben folgende Möglichkeiten:

• Wählen Sie das Selector- oder Grabber-Tool, 
klicken Sie mit der rechten Maustaste auf den 
Clip und wählen Sie aus dem Untermenü 
„Matches“ des Popup-Menüs einen Take. 

• Halten Sie bei Verwendung des Selector-Tools 
die Befehlstaste (Mac) bzw. die Strg-Taste 
(Windows) gedrückt und klicken Sie am 
genauen Anfang des Loop- oder Punch-
Bereichs. Nun können Sie einen anderen Take 
aus dem Alternates-Popup-Menü wählen.

Weitere Methoden zum Festlegen des 
Aufnahmebereichs finden Sie unter 
„Festlegen der Punch- und Loop-Punkte“ 
auf Seite 459.

Auswählen eines alternativen MIDI-Takes



Pro Tools-Referenzhandbuch494

• Wenn der gerade in der Spur befindliche Take 
selektiert ist, halten Sie die Befehlstaste (Mac) 
bzw. die Strg-Taste (Windows) gedrückt und 
klicken Sie mit dem Selector-Tool auf eine 
beliebige Stelle des selektierten Takes. Nun 
können Sie einen anderen Take aus dem 
Alternates-Popup-Menü wählen.

Der ausgewählte Take (Clip) ersetzt den 
vorherigen Take und wird genau an der richtigen 
Position eingefügt.

MIDI Step Input
Mit „Step Input“ können Sie einzelne Noten 
schrittweise über ein MIDI-Keyboard (oder einen 
anderen MIDI-Controller, der MIDI-Notendaten 
sendet) eingeben. Dadurch erhalten Sie 
uneingeschränkte Kontrolle über die Platzierung, 
Länge und Velocity der Noten. Mit „MIDI Step 
Input“ können Sie daher Passagen eines 
Musikstücks erstellen, die sonst nur äußerst 
schwer mit einer derartigen Präzision oder 
höherem Tempo gespielt werden könnten. 

Aufnehmen von System 
Exklusive-Daten
Pro Tools unterstützt Aufnahme und Wiedergabe 
von systemexklusiven Daten (Sysex) auf MIDI-
Spuren. Dies ermöglicht die Verwendung von 
MIDI-Spuren in Pro Tools zum Speichern von 
Programm- und Konfigurationsdaten für Ihr MIDI-
Gerät oder zur Aufnahme von Echtzeit-Sysex-
Änderungen für einen MIDI-Geräteparameter, 
der nicht über den Standard-MIDI-Controller 
gesteuert werden kann.

So nehmen Sie einen Sysex-Dump am Anfang 
einer MIDI-Spur auf:

1 Stellen Sie sicher, dass der MIDI-Ausgang 
(MIDI OUT) des Sendegeräts mit dem MIDI-
Eingang (MIDI IN) Ihres MIDI-Interface 
verbunden ist.

2 Aktivieren Sie im MIDI Input Filter-Dialogfeld 
die Optionen Only und System Exclusive.

3 Konfigurieren Sie eine MIDI-Spur für die 
Aufnahme (siehe „Konfigurieren von MIDI- 
oder Instrumentenspuren für die Aufnahme“ 
auf Seite 484).

4 Vergewissern Sie sich, dass der 
Aufnahmemodus „Normal“ aktiviert ist (siehe 
„Aufnahmemodi“ auf Seite 436).

5 Schalten Sie eine MIDI-Spur scharf.

6 Aktivieren Sie im Transport-Fenster die Wait 
for Note-Option.

7 Um mit der Aufnahme am Anfang der Session 
zu beginnen, klicken Sie im Transport-Fenster 
auf „Return to Zero“.

8 Klicken Sie im Transport-Fenster auf „Record“, 
wenn Sie mit der Aufnahme beginnen möchten. 

Weitere Informationen zum Abhören 
und Verwalten von Takes finden Sie unter 
„Selektieren alternativer Takes“ auf Seite 472.

Weitere Informationen zu Step Input finden 
Sie unter „Step Input“ auf Seite 962.
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Die Schaltflächen „Record“, „Play“ und „Wait for 
Note“ blinken und zeigen damit an, dass Pro Tools 
auf MIDI-Daten wartet.

9 Starten Sie die Übertragung der Sysex-Daten 
vom MIDI-Gerät entsprechend den 
Anleitungen des Herstellers. Die Aufnahme 
startet in Pro Tools automatisch, sobald die 
ersten Sysex-Daten empfangen werden.

10 Klicken Sie im Transport-Fenster auf „Stop“, 
wenn die Sysex-Übertragung abgeschlossen ist.

Die neu aufgenommenen MIDI-Daten werden als 
MIDI-Clip in der Playlist der Spur angezeigt und 
in der Clipliste aufgeführt. Wenn das 
Darstellungsformat der MIDI-Spur auf Clips 
eingestellt ist, erscheinen die MIDI-Clips mit den 
Sysex-Daten leer.

Um die Sysex-Event-Blöcke mit der Position der 
Daten anzuzeigen, stellen Sie die Spurdarstellung 
auf Sysex ein (siehe „Clip-Darstellung für MIDI- 
und Instrumentenspuren“ auf Seite 530). 

So senden Sie Sysex-Daten von Pro Tools an ein 
externes MIDI-Gerät:

1 Stellen Sie sicher, dass der MIDI IN-Port des 
Geräts, das die Sysex-Daten empfangen soll, 
mit dem MIDI OUT-Port Ihres MIDI-Interface 
verbunden ist. Vergewissern Sie sich außerdem, 
dass das Gerät für den Empfang von Sysex-
Daten eingestellt ist. Bei manchen Geräten 
muss hierzu die Memory Protect-Funktion 
(Speicherschutz) ausgeschaltet sein. Weitere 
Informationen finden Sie in den Anweisungen 
des Herstellers.

2 Stellen Sie sicher, dass die MIDI-Spur mit dem 
vorherigen Take nicht scharfgeschaltet ist.

3 Klicken Sie auf den MIDI Output-Selektor der 
Spur und weisen Sie im Popup-Menü das 
entsprechende Gerät zu.

4 Konfigurieren Sie das externe MIDI-Gerät 
gemäß den Anweisungen des Herstellers für 
den Empfang von Sysex-Daten.

5 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten. Pro Tools 
beginnt mit der Wiedergabe und überträgt die 
zuvor aufgenommenen Sysex-Daten auf das 
zugewiesene MIDI-Gerät.

Aufnehmen von Audiomaterial 
von einem MIDI-Instrument
Normalerweise wird Audio über MIDI-
Instrumente (Hardware und Plug-Ins) mithilfe von 
Instrumenten- und Auxiliary-Eingangs-Spuren 
abgehört. Beim endgültigen Mixdown kann 
Audiomaterial aus Instrumenten- oder Auxiliary-
Eingangs-Spuren aufgenommen werden, wenn 
„Bounce to Disk“ verwendet wird oder die 
Aufnahme auf eine neue Spur über einen über Busse 
geleiteten Aufnahmepfad erfolgt. 

Weitere Informationen zum Verschieben und 
Kopieren von Sysex-Daten finden Sie unter 
„System Exclusive-Events“ auf Seite 721.

Bei der Verwendung von Instrumenten-Plug-
Ins möchten Sie möglicherweise vor dem 
Mischen Audio über ein MIDI-Instrument auf 
eine neue Spur aufnehmen, um DSP-
Ressourcen freizusetzen.
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Aufnehmen von Audio von einem 
Instrumenten-Plug-In

So nehmen Sie Audio von einem Instrumenten-
Plug-In auf:

1 Erstellen Sie eine neue Instrumentenspur.

2 Fügen Sie auf dieser Spur ein Instrumenten-
Plug-In ein.

3 Sie haben folgende Möglichkeiten:

• Nehmen Sie Ihre MIDI-Daten auf der 
Instrumentenspur auf.

• Geben Sie MIDI-Daten manuell in die 
Instrumentenspur ein.

4 Erstellen Sie eine neue Audiospur mit derselben 
Anzahl an Kanälen wie bei der 
Instrumentenspur (beispielsweise Stereo).

5 Stellen Sie den Audio-Output Path-Selektor der 
Instrumentenspur auf einen Bus ein 
(beispielsweise Bus 1–2).

6 Stellen Sie den Audio-Input Path-Selektor der 
Audiospur auf denselben Bus ein.

7 Stellen Sie den Audio-Output Path-Selektor der 
Audiospur auf den Haupt-Monitor-Pfad ein.

8 Schalten Sie die Audiospur scharf.

9 Sie haben folgende Möglichkeiten:

• Um vom Beginn der Session aus aufzunehmen, 
klicken Sie im Transport-Fenster auf „Return to 
Zero“.

• Vornehmen einer Timeline-Selektion für den 
Aufnahmebereich

10 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

11 Klicken Sie im Transport-Fenster auf „Play“, 
um die Aufnahme zu starten.

12 Wenn das zuvor aufgenommene MIDI-Material 
fertig ist, klicken Sie im Transport-Fenster auf 
„Stop“, um die Aufnahme anzuhalten.

Sie können die gewünschten MIDI- und 
Audiodaten auch gleichzeitig aufnehmen.

Bus-Audioaufnahme von einem Instrumenten-Plug-In
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Aufnehmen von 
Audiomaterial von einem 
externen MIDI-Instrument
Sie haben folgende Möglichkeiten, um 
Audiomaterial von einem externen MIDI-
Instrument aufzunehmen:

• Aufnehmen von Audiodaten vom Ausgang der 
Instrumentenspur (oder Auxiliary-Eingangs-
Spur), die zum Abhören des MIDI-Instruments 
verwendet wird, über eine Audiospur. 

• Festlegen des Audio-Input Path-Selektors der 
Audiospur auf den Audio-Eingangspfad der 
Instrumentenspur (oder Auxiliary-Eingangs-
Spur), die zum Abhören des externen MIDI-
Instruments verwendet wird. 

Die zweite Methode schließt jegliche zusätzliche 
Latenz aus, die mit Bus-Aufnahmen verbunden ist. 
Achten Sie dabei jedoch unbedingt darauf, die 
Instrumentenspur (oder Auxiliary-Eingangs-
Spur), die zum Abhören verwendet wird, während 
der Aufnahme desselben Audiopfads auf der 
Audiospur stummzuschalten.
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Kapitel 23: Punch-Aufnahmemodi

Punch-Aufnahme wird in vielen Bereichen 
der Audioproduktion für Film, Video und 
Musik verwendet.

Einführung in die Punch-
Aufnahmemodi
Sobald das Spur-Basismaterial aufgenommen ist, 
muss häufig ein Teil des Audiomaterials, aus dem 
eine Spur besteht, ersetzt werden. Mithilfe der 
Punch-Aufnahme können Sie während 
der Aufnahme Punch-Vorgänge für eine oder 
mehrere Audiospuren ausführen, ohne den 
Transport anzuhalten. 

Pro Tools-Punch-Aufnahmemodi
Pro Tools bietet drei verschiedene manuelle 
Punch-Aufnahmemodi: 

Der QuickPunch – ein nicht destruktiver 
Aufnahmemodus, der während der Wiedergabe 
durch Klicken auf die Record-Schaltfläche 
im Transport-Fenster das Punch-In und Punch-Out 
auf scharfgeschalteten Spuren ermöglicht. Der 
QuickPunch-Modus ist in allen Systemen 
verfügbar. 

TrackPunch (nur Pro Tools HD) – ein nicht 
destruktiver Aufnahmemodus, der das Punch-In, 
Punch-Out oder Aufheben der Scharfschaltung von 
einzelnen Spuren ohne Unterbrechung der Online-
Aufnahme und -Wiedergabe ermöglicht.

DestructivePunch (nur Pro Tools HD) – ein 
destruktiver Aufnahmemodus, der pro Punch-Spur 
eine einzige kontinuierliche Audiodatei beibehält 
und außerdem das Punch-In, Punch-Out oder 
Aufheben der Scharfschaltung von einzelnen 
Spuren ohne Unterbrechung der Online-Aufnahme 
und -Wiedergabe ermöglicht.

Bei MIDI-Spuren ist es nicht notwendig, für 
Punch-Aufnahmen QuickPunch oder einen 
anderen Audio-Punch-Aufnahmemodus 
zu verwenden. Punch-Vorgänge können bei 
MIDI-Spuren in den Aufnahmemodi „Normal 
(Nondestructive)“ und „Destructive“ 
ausgeführt werden.

Informationen zum automatischen Punch-In 
und Punch-Out auf scharfgeschalteten 
Audiospuren in einem bestimmten Bereich 
finden Sie unter „Punch-Aufnahme von 
Audiomaterial über einen festgelegten 
Bereich“ auf Seite 465.
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Richtlinien für die Punch-
Aufnahme
In diesem Abschnitt sind die grundlegenden 
Einstellungen und Richtlinien für die Punch-
Aufnahme in Pro Tools aufgeführt, unter anderem: 

• „Voice-Anforderungen für die Punch-
Aufnahme“ auf Seite 500. 

• „Delay Compensation und DestructivePunch-
Modus“ auf Seite 501.

• „Audiodateien, Clips und Takes“ auf Seite 502.

• „Einstellungen für die Punch-Aufnahme“ auf 
Seite 503 (für Crossfades sowie Transport- und 
Monitor-Konfigurationseinstellungen)

Voice-Anforderungen für die 
Punch-Aufnahme
Die maximale Anzahl der Spuren, auf denen Punch-
Vorgänge ausgeführt werden können, hängt von der 
Art des verwendeten Systems sowie von der Anzahl 
der verfügbaren Voices ab. In den folgenden 
Abschnitten finden Sie Richtlinien für die Voice-
Auslastung bei der Punch-Aufnahme, die für die 
Verwendung von Ressourcen während Sessions 
nützlich sein können. 

Pro Tools

(Nur QuickPunch)

QuickPunch-Funktionen für Pro Tools hängen von 
der Gesamtanzahl der verfügbaren Voices ab. 
Diese wiederum hängt von der Anzahl der Spuren 
und Plug-Ins ab, die in der aktuellen Session 
verwendet werden. 

So machen Sie weitere Voices für die Punch-
Aufnahme verfügbar:

1 Ermitteln Sie Spuren, die nicht scharfgeschaltet 
sind und während der Aufnahme nicht gehört 
werden müssen.

2 Deaktivieren Sie diese Spuren. 

Pro Tools HD

(QuickPunch, TrackPunch und 
DestructivePunch)

Wenn Sie einen beliebigen Punch-
Aufnahmemodus unter Pro Tools HD verwenden, 
werden für jede scharfgeschaltete Monospur 
zwei Voices benötigt. Sie können also maximal 
halb so viele Spuren mittels Punch-Vorgang 
aufnehmen, wie auf Ihrem System Voices zur 
Verfügung stehen.

Wenn beim Umschalten in den QuickPunch, 
TrackPunch- oder DestructivePunch-Modus 
die benötigte Anzahl von Voices für die 
scharfgeschalteten Spuren nicht zur Verfügung 
steht, werden Sie zum Freigeben der 
erforderlichen Voices aufgefordert.

QuickPunch beansprucht CPU-
Rechenleistung. Die Anzahl der 
verwendbaren Spuren und Plug-Ins kann 
dementsprechend eingeschränkt sein.

Ausführliche Informationen zur Voice-
Funktionen finden Sie unter „Pro Tools-
Systemfunktionen mit unterschiedlichen 
Hardware-Konfigurationen“ auf Seite 41.
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So machen Sie weitere Voices für die Punch-
Aufnahme verfügbar:

 Ermitteln Sie Spuren, die nicht scharfgeschaltet 
sind und während der Aufnahme nicht gehört 
werden müssen. Führen Sie dann einen der 
folgenden Schritte aus:

• Stellen Sie die Voice-Zuweisungen der 
entsprechenden Spuren auf „Off“.

• Deaktivieren Sie die Spuren.

• Gruppieren Sie alle Native-Plug-Ins vor DSP-
Plug-Ins.

Voices, die von anderen Spuren verwendet 
werden, jedoch nicht scharfgeschaltet sind, können 
während der Punch-Aufnahme bei Bedarf 
„gestohlen“ werden. 

Wenn ein Punch-Aufnahmemodus aktiviert ist, ist 
die Voice-Wiedergabepriorität folgendermaßen 
festgelegt (von der höchsten zur niedrigsten 
Wiedergabepriorität):

• nicht scharfgeschaltete Spuren mit 
zugewiesenen Voices

• scharfgeschaltete Spuren mit zugewiesenen 
Voices

• nicht scharfgeschaltete Spuren mit dynamisch 
zugewiesenen Voices

• scharfgeschaltete Spuren mit dynamisch 
zugewiesenen Voices

Wenn in der Session ausreichend Voices zur 
Verfügung stehen, dürfte die Punch-Aufnahme auf 
Spuren mit dynamisch zugewiesenen Voices keine 
Probleme bereiten. Wenn jedoch zu wenig Voices 
verfügbar sind und Sie sicherstellen möchten, dass 
eine Spur bei der Punch-Aufnahme gehört werden 
kann, sollten Sie die nicht benötigten Voice-
Spuren auf Off schalten.

Delay Compensation und 
DestructivePunch-Modus
Bei Verwendung des DestructivePunch-Modus für 
das Punch-In auf eine bestehende Aufnahme 
sollten Sie sicherstellen, dass die Delay 
Compensation-Einstellungen den Einstellungen 
bei der Aufnahme der ursprünglichen Datei 
entsprechen. Wenn die Einstellungen 
unterschiedlich sind, ist das Punch-In-
Audiomaterial zeitlich nicht mit der 
ursprünglichen Aufnahme identisch.

 Wenn Delay Compensation bei der Aufnahme 
der ursprünglichen Datei nicht aktiviert war, sollte 
es bei Verwendung von DestructivePunch 
deaktiviert werden.

 Wenn Delay Compensation bei der Aufnahme 
der ursprünglichen Datei aktiviert war, sollte es bei 
Verwendung von DestructivePunch aktiviert 
bleiben. 

Um sicherzustellen, dass der Delay 
Compensation-Pfad auf aufgenommenen Spuren 
unter Verwendung von DestructivePunch 
konsistent bleibt, müssen Sie verhindern, dass 
Pro Tools den Niedriglatenz-Monitoringpfad 
verwendet, wenn aufgenommene Spuren in den 
Eingangsabhörmodus wechseln.

Sie haben folgende Möglichkeiten, Delay 
Compensation auf eine Spur anzuwenden, für die 
Delay Compensation ausgesetzt war:

 Klicken Sie mit der rechten Maustaste auf die 
Track Compensation-Anzeige auf der Spur und 
wählen Sie Auto Low Latency Off.

 Halten Sie Befehl + Ctrl (Mac) bzw. Strg + 
Windows (Windows) gedrückt und klicken Sie 
auf die Track Compensation-Anzeige auf der 
Spur.
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Sie haben folgende Möglichkeiten, Delay 
Compensation auf alle ausgewählten Spuren 
anzuwenden, für die Delay Compensation 
ausgesetzt war:

 Klicken Sie bei gedrückter Umschalttaste mit 
der rechten Maustaste auf die Track 
Compensation-Anzeige der Spur und wählen 
Sie Auto Low Latency Off.

 Halten Sie Befehl + Ctrl + Umschalt (Mac) 
bzw. Strg + Windows + Umschalt (Windows) 
gedrückt und klicken Sie auf die Track 
Compensation-Anzeige der Spur.

Audiodateien, Clips und Takes

QuickPunch- und TrackPunch-Modus

QuickPunch und TrackPunch sind nichtdestruktive 
Aufnahmemodi. Beim Punch-Vorgang wird 
Audiomaterial nicht ersetzt. Stattdessen werden im 
QuickPunch- und TrackPunch-Modus neue 
Audiodateien für jeden Durchgang (ein Durchgang 
ist ein Zyklus vom Starten bis zum Anhalten des 
Transports) erstellt.

Pro Tools startet die Aufnahme einer neuen 
Audiodatei mit dem Starten der Wiedergabe. 
Dabei werden an jedem Punch-In- und Punch-Out-
Punkt automatisch Clips erstellt. In einem einzigen 
Durchgang können bis zu 200 dieser „Running 
Punches“ durchgeführt werden. QuickPunch und 
TrackPunch bieten sofortige Monitor-
Umschaltung bei Punch-Out. 

Nach der QuickPunch- oder TrackPunch-Aufnahme 
werden die neuen Audioclips in der Clipliste 
angezeigt. Dies umfasst die Audioclips, die eine 
ganze Datei umfassen, einschließlich aller Punch-
Vorgänge aus dem Aufnahmedurchgang und der 
Clips, die sich für jeden Punch ableiten.

Die Namen der Punch-Clips sind, beginnend 
bei „01“, mit einer fortlaufenden Nummerierung 
versehen. Wenn Sie mit QuickPunch etwa einen 
zweimaligen Punch-In-Vorgang auf einer Spur 
namens „Lead Gtr“ durchführen, werden für die 
übergeordnete Audiodatei ein mit „Lead Gtr_01“ 
bezeichneter Clip und für die „Punches“ zwei mit 
„Lead Gtr_01-01“ und „Lead Gtr_01-02“ 
bezeichnete Clips angezeigt. 

Wenn Sie die Wiedergabe anhalten und 
zusätzliche Punch-Aufnahmen mit QuickPunch 
(oder TrackPunch) machen, wird ein vollständig 
neuer Dateiclip erstellt (da für jeden Durchgang 
einer erstellt wird) und nachfolgende Clips werden 
benannt, indem die ersten beiden Stellen im 
Namen erhöht werden. Im zweiten Durchgang 
werden die Punch-Clips z. B. „Lead Gtr_02-01“, 
„Lead Gtr_02-02“ usw. benannt. 

DestructivePunch-Modus

DestructivePunch ist ein destruktiver 
Aufnahmemodus, der bereits vorhandenes 
Spurmaterial durch neu aufgenommenes Punch-
Audiomaterial dauerhaft ersetzt. Pro Tools nimmt 
nur während des Punch-In-Vorgangs der Spuren 
auf. Dabei wird neues Material eingeschliffen und 
das Audiomaterial in der Spur-Playlist ersetzt. 

Weitere Informationen finden Sie 
unter „Verzögerungsausgleich“ auf 
Seite 1024.
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Einstellungen für die Punch-
Aufnahme
(Crossfade-, Transport- und Record-
Einstellungen)

Pro Tools bietet verschiedene 
Voreinstellungsmöglichkeiten für Punch-
Vorgänge, über die Sie festlegen können, wie 
Crossfades, Monitor- und Transportfunktionen 
während und nach Aufnahmedurchgängen 
ausgeführt werden. Mit diesen Einstellungen wird 
das Verhalten von Fades, Transport und Spuren in 
Pro Tools für verschiedene Arten von Aufgaben, 
einschließlich Dubben, Mischen und 
Overdubbing, optimiert. 

Crossfades während der Punch-Aufnahme

Pro Tools platziert Crossfades an jedem In- und 
Out-Punkt, um fließende Übergänge zwischen 
Punch-Clips zu ermöglichen. Sie können die 
Crossfade-Länge für den Quick-Punch- und 
TrackPunch-Modus festlegen. (DestructivePunch 
verwendet eine feste Crossfade-Länge, die nicht 
geändert werden kann.) Nach Abschluss der 
Punch-Aufnahme können alle Crossfades auf 
dieselbe Art und Weise wie standardmäßige 
Crossfades bearbeitet werden (siehe Kapitel 28: 
„Fades und Crossfades“). 

QuickPunch/TrackPunch Crossfade Length

Pro Tools kann im QuickPunch- oder TrackPunch-
Modus automatisch einen Crossfade für jeden 
Punch-Punkt erzeugen. Die Länge dieser 
Crossfades wird über die Option 
QuickPunch/TrackPunch Crossfade Length in den 
Editing-Voreinstellungen festgelegt.

So stellen Sie die Option „QuickPunch/TrackPunch 
Crossfade Length“ ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Editing-Registerkarte.

2 Geben Sie einen neuen Wert (in ms) für 
QuickPunch/TrackPunch Crossfade Length ein. 
Im Allgemeinen empfiehlt sich für Punch-
Vorgänge eine Crossfade-Länge von 
10 Millisekunden. Wenn Sie den Wert auf Null 
setzen, erstellt Pro Tools keine Crossfades an 
den Punch-In- und Punch-Out-Punkten.

3 Klicken Sie auf OK.

Ist für QuickPunch/TrackPunch Crossfade Length 
ein anderer Wert als Null angegeben, erzeugt 
Pro Tools einen Pre-Crossfade am Punch-In-Punkt 
(genau bis zum Beginn des Punch-Clips, aber nicht 
in den Punch-Clip hinein) und einen Post-
Crossfade am Punch-Out-Punkt (beginnend am 
Punch-Out-Punkt über den Punch-Clip hinaus).

Unabhängig von der aktuellen Einstellung für 
„QuickPunch/TrackPunch Crossfade Length“ führt 
Pro Tools immer einen Crossfade von 
4 Millisekunden durch, der ausschließlich zum 
Abhören dient und nicht auf den Datenträger 
geschrieben wird. Dies verhindert störende Klick- 
oder Knackgeräusche, die beim Aktivieren und 
Beenden des Aufnahmemodus auftreten können.

DestructivePunch und Crossfades

DestructivePunch verwendet an jedem In- und 
Out-Punkt einen festen, linearen 10-
Millisekunden-Crossfade. Nach Abschluss der 
Punch-Aufnahme können diese Crossfades auf 
dieselbe Art und Weise wie standardmäßige 
Crossfades bearbeitet werden (siehe Kapitel 28: 
„Fades und Crossfades“). 
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Transport- und Aufnahmeeinstellungen

Transport- und Aufnahmeeinstellungen für die 
Punch-Aufnahme finden Sie auf der Operation 
Preferences-Registerkarte. Mithilfe dieser 
Voreinstellungen wird festgelegt, wie sich der 
Aufnahmestatus der Spur und des Transports 
während, zwischen und nach Punch-Vorgängen 
und Durchgängen ändert.

Transport RecordLock

Mit dieser Einstellung kann die Record-
Schaltfläche im Transport-Bereich so konfiguriert 
werden, dass entweder ein Digital Dubber 
simuliert oder das frühere Verhalten des 
Hauptaufnahmeschalters (Record) beibehalten 
wird. 

 Wenn diese Funktion nicht aktiviert ist, wird die 
Record-Schaltfläche im Transport-Bereich 
deaktiviert, sobald Pro Tools manuell angehalten 
wird oder aufgrund eines Timecode-Verlusts 
anhält. Dieses Verhalten entspricht dem 
Aufnahmeverhalten von früheren Pro Tools-
Versionen. 

 Wenn die RecordLock-Funktion aktiviert ist, 
bleibt die Record-Schaltfläche im Transport-
Bereich bei Anhalten der Wiedergabe oder 
Aufnahme scharfgeschaltet. Damit wird die 
erneute Scharfschaltung des Transports zwischen 
den Takes überflüssig. Ein solches Verhalten 
simuliert das eines Digital Dubbers. 

Destruktives Aufnehmen und Transport RecordLock

Zur Vermeidung von ungewolltem Aufnehmen auf 
bereits bestehendem Material ist die Transport 
RecordLock-Voreinstellung automatisch 
deaktiviert und ausgegraut, wenn der 
Aufnahmemodus „Destructive“ aktiviert ist. 

Audio Track RecordLock

Mit dieser Einstellung können Pro Tools-Spuren 
entweder einen Digital Dubber simulieren oder das 
frühere Verhalten für den Spuraufnahme-Status 
beibehalten. 

 Wenn die Audio Track RecordLock-
Voreinstellung aktiviert ist, bleiben die 
scharfgeschalteten Audiospuren bei Ende der 
Wiedergabe oder Aufnahme weiterhin 
scharfgeschaltet. 

 Wenn die Audio Track RecordLock-Option 
nicht aktiviert ist, wird die Scharfschaltung von 
Audiospuren aufgehoben, sobald Pro Tools 
angehalten wird. Dadurch wird vermieden, dass 
Spuren von einem Durchgang zum nächsten 
scharfgeschaltet bleiben (Simulation des 
Spuraufnahmeverhaltens eines Digital Dubber).

TrackPunch-Voreinstellungen

Wenn Sie während der Aufnahme ein Punch-
Out vornehmen, indem Sie im Transport-
Bereich den Record-Schalter drücken, wird 
die Scharfschaltung des Transports 
aufgehoben.

Beispiele zur Anwendung dieser 
Einstellungen finden Sie unter „Beispiele für 
TrackPunch- und DestructivePunch-
Workflows“ auf Seite 518.
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Synchronisations- und 
Spurscharfschaltungsoptionen 
für die Punch-Aufnahme
(Nur SYNC HD)

Die Synchronisationseinstellungen für die Online-
Punch-Aufnahme variieren je nach Typ und 
Funktionen des Pro Tools-Systems sowie anderer 
Geräte in Ihrem Studio. 

Die Option MachineControl™ für Pro Tools HD 
ermöglicht Ihnen, Spuren auf unterstützten 9-Pin-
Geräten (bzw. nur für den Transport auf V-LAN-
Geräten) für die Aufnahme ferngesteuert 
scharfzuschalten (Remote Track Arming). 

QuickPunch-Audioaufnahme
QuickPunch ist auf allen Systemen verfügbar und 
ermöglicht das automatische Punch-In und Punch-
Out auf allen scharfgeschalteten Audiospuren 
während der Wiedergabe durch Klicken auf die 
Record-Schaltfläche im Transport-Fenster. 

Aufnehmen mit QuickPunch

So führen Sie Punch-Aufnahmen mit QuickPunch 
durch:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Options > QuickPunch. 

• Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Record-Schaltfläche 
und wählen Sie QuickPunch.

Wenn QuickPunch aktiviert ist, wird auf der 
Record-Schaltfläche im Transport-Fenster ein „P“ 
angezeigt. 

2 Überprüfen Sie die Crossfade-Einstellung für 
die Punch-Aufnahme bzw. konfigurieren Sie sie 
ggf. neu (siehe „QuickPunch/TrackPunch 
Crossfade Length“ auf Seite 503).

3 Klicken Sie auf die Record Enable-Schaltfläche 
der Spur, um jede Spur scharfzuschalten, auf 
der Punch-In durchgeführt werden soll. 

Grundlegende Informationen zu Timecode 
und Synchronisation für Pro Tools finden Sie 
in Kapitel 50: „Synchronisation in 
Pro Tools“.

Wählen Sie „Setup > Machine Track Arming 
Profiles“, um Ihr System zu konfigurieren, 
und wählen Sie „Window > Machine Track 
Arming“, um das Fenster „Machine Track 
Arming“ anzuzeigen. 

Informationen zum ferngesteuerten 
Scharfschalten von Spuren mit 
MachineControl finden Sie im 
MachineControl-Handbuch. 

Viele Pro Tools-Systeme bieten außerdem die 
Möglichkeit, einen Fußschalter für Punch-In- 
und Punch-Out-Vorgänge zu verwenden. 
Informationen finden Sie auch in dem 
Handbuch zu Pro Tools-Audio-Interface und 
-Bedienoberfläche.

QuickPunch aktiviert
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4 Bereiten Sie die Aufnahme vor, indem Sie mit 
Pro Tools die entsprechende Position ansteuern. 
Wenn Sie Pre-Roll verwenden möchten, 
aktivieren Sie im Transport-Fenster einen Pre-
Roll-Wert.

5 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

6 Sie haben folgende Möglichkeiten:

• Klicken Sie im Transport-Fenster auf „Record“, 
wenn Sie den Punch-In-Punkt erreicht haben.

• Bei Pro Tools-Systemen, die die Verwendung 
eines angeschlossenen Fußschalters 
unterstützen, betätigen Sie am Punch-In-Punkt 
den Fußschalter.

Die Record-Schaltfläche hört auf zu blinken und 
leuchtet während der gesamten Aufnahme.

7 Um einen Punch-Out-Vorgang durchzuführen, 
klicken Sie erneut auf „Record“ (bzw. betätigen 
Sie den Fußschalter).

Während Pro Tools mit der Wiedergabe fortfährt, 
können Sie weitere Punch-Vorgänge (maximal 
200) durchführen. Wenn in einem Durchgang 
mehrere „Punches“ aufgenommen werden, wird 
eine einzige Audiodatei aufgezeichnet, die 
Pro Tools zur Erstellung der entsprechenden Clips 
verwendet.

Nach einem QuickPunch-Aufnahmedurchgang 
werden im Edit-Fenster in der Playlist der Punch-
Spur die beim Punch-Vorgang erzeugten Clips 
angezeigt. Sie können nach der Punch-Aufnahme 
alle Trim-Werkzeuge verwenden, um den 
Spuranfang oder das Spurende der mit QuickPunch 
aufgenommenen Clips zu öffnen oder um die 

übergeordnete Audiodatei anzuzeigen, die im 
Hintergrund aufgenommen wurde. Auf diese Weise 
können Sie zu spät oder überhaupt nicht ausgeführte 
Punches ausgleichen. 

Informationen zur Benennung von Dateien und 
Clips finden Sie unter „Audiodateien, Clips und 
Takes“ auf Seite 502. 

QuickPunch in einer Edit-Selektion

Bei der Verwendung von QuickPunch mit einer 
Edit-Selektion gelten folgende Regeln:

• Wenn sich Transport nicht im Online-Modus 
befindet, wird die Aufnahme durch Klicken auf 
die Record-Schaltfläche im Transport-Fenster 
(unabhängig von Start- und Endpunkt der 
Selektion) gestartet bzw. angehalten. 

• Wenn Transport online ist, wird die Punch-In- 
und Punch-Out-Funktion durch die Online 
Options-Einstellung auf der Operation 
Preferences-Registerkarte gesteuert. 

• Bei aktivierter Option Record Online at 

Insertion/Selection führt QuickPunch Punch-
In- und Punch-Out-Vorgänge nur innerhalb 
der Selektion (oder, falls vorhanden, nur nach 
dem Einfügepunkt) durch. 

• Wenn Sie Record Online at Timecode Lock 
auswählen, ignoriert QuickPunch die 
Selektion und führt Punch-In- und Punch-
Out-Vorgänge durch, wann immer Sie es 
wünschen (nachdem Pro Tools auf den 
Timecode eingerastet ist).

Informationen für den Fall, dass Sie Spuren 
aufgrund von Voice-Beschränkungen nicht 
scharfschalten können, finden Sie unter 
„Voice-Anforderungen für die Punch-
Aufnahme“ auf Seite 500.

Informationen zur Online-Wiedergabe 
mit Pro Tools finden Sie in dem 
im Lieferumfang Ihres Systems enthaltenen 
Benutzerhandbuch. Informationen zur 
Synchronisation mit TrackPunch- und 
DestructivePunch-Aufnahme finden Sie unter 
„Synchronisations- und 
Spurscharfschaltungsoptionen für die Punch-
Aufnahme“ auf Seite 505. 
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TrackPunch-Audioaufnahme
(Nur Pro Tools HD)

Im TrackPunch-Modus können Sie Punch-In- und 
Punch-Out-Vorgänge für jeweils einzelne Spuren 
oder auch für mehrere Spuren gleichzeitig 
durchführen. TrackPunch ist ein nicht destruktiver 
Punch-Modus, der vorheriges Material auf dem 
Datenträger belässt. (Informationen zum 
destruktiven Ersetzen von Audiomaterial auf 
einem Datenträger finden Sie unter 
„DestructivePunch-Audioaufnahme“ auf 
Seite 512.) 

TrackPunch-Setup
Vor der Verwendung von TrackPunch in einem 
Aufnahmedurchgang müssen Sie die Pro Tools-, 
Session- und Spureinstellungen konfigurieren.

Konfigurieren von Pro Tools

So konfigurieren Sie Pro Tools: 

1 Konfigurieren Sie Spur-, Voice- und andere 
TrackPunch-Einstellungen nach Bedarf (siehe 
„Richtlinien für die Punch-Aufnahme“ auf 
Seite 500). 

2 Stellen Sie sicher, dass Pro Tools gerade keine 
Aufnahme oder Wiedergabe ausführt, d. h. der 
Transport angehalten ist. 

Aktivieren des TrackPunch-Modus

So aktivieren Sie den TrackPunch-Modus:

 Sie haben folgende Möglichkeiten: 

• Wählen Sie Options > QuickPunch.

• Klicken Sie im Transport-Fenster mit 
der rechten Maustaste auf die Record-
Schaltfläche und wählen Sie im Popup-Menü 
TrackPunch.

• Halten Sie die Windows-Taste (Windows) bzw. 
die Ctrl-Taste (Mac) gedrückt und klicken 
Sie im Transport-Fenster auf die Record-
Schaltfläche. Blättern Sie so durch die 
verfügbaren Aufnahmemodi, bis der 
TrackPunch-Modus ausgewählt ist (angezeigt 
mit einem „T“). 

• Drücken Sie Befehl + Umschalt + T (Mac) bzw. 
Strg + Umschalt + T (Windows).

Anzeige des TrackPunch-Status im 
Transport-Bereich

Die Record-Schaltfläche im Transport-Bereich 
zeigt den TrackPunch- und Aufnahmestatus wie 
folgt an:

Bei aktiviertem TrackPunch-Modus:

 Auf der Record-Schaltfläche im Transport-
Fenster wird ein „T“ angezeigt. 

 Wenn für mindestens eine Spur der 
TrackPunch-Modus aktiviert ist, leuchtet die 
Record-Schaltfläche blau. 

Status-Anzeigen für TrackPunch und TrackInput im 
Transport-Fenster

TrackPunch-Modus mit mindestens einer Spur, für die 
TrackPunch aktiviert ist

TrackPunch 
aktiviert

Scharfschaltestatus-
Anzeige

Eingangsstatus-Anzeige



Pro Tools-Referenzhandbuch508

Bei aktiviertem TrackPunch-Modus und für die 
Aufnahme scharfgeschaltetem Transport:

 Wenn für keine Spur der TrackPunch-Modus 
aktiviert ist, blinkt die Record-Schaltfläche im 
Transport-Fenster grau und rot. 

 Wenn für mindestens eine Spur der 
TrackPunch-Modus aktiviert ist, blinkt 
die Record-Schaltfläche im Transport-Fenster blau 
und rot.

 Wenn für mindestens eine Spur der 
TrackPunch-Modus und zugleich die 
Scharfschaltung aktiviert ist, blinkt die Record-
Schaltfläche blau und rot und die Aufnahme-LED 
leuchtet.

 Wenn auf mindestens einer Audiospur 
aufgenommen wird, leuchtet die Record-
Schaltfläche im Transport-Bereich rot. 

Aktivieren des TrackPunch-
Modus für Spuren
Sie müssen vor jedem Durchgang für alle Spuren, 
für die Sie Punch-Vorgänge ausführen möchten, 
den TrackPunch-Modus aktivieren. (Sie können 
den TrackPunch-Modus für Spuren aktivieren, 
ohne sie scharfzuschalten.) 

So aktivieren Sie den TrackPunch-Modus für eine 
Audiospur: 

 Klicken Sie bei gedrückter Ctrl-Taste (Mac) 
oder Windows-Taste (Windows) auf die Record 
Enable-Schaltfläche der Spur. 

So aktivieren oder deaktivieren Sie den 
TrackPunch-Modus für alle Audiospuren:

 Drücken Sie Wahl + Ctrl (Mac) oder Alt + 
Windows (Windows) und klicken Sie auf die 
Record Enable-Schaltfläche der Spur. 

So aktivieren oder deaktivieren Sie den 
TrackPunch-Modus für alle ausgewählten 
Audiospuren: 

 Drücken Sie Wahl + Ctrl + Umschalt (Mac) 
oder Alt + Windows + Umschalt (Windows) 
und klicken Sie auf die Record Enable-
Schaltfläche der Spur. 

Wenn der TrackPunch-Modus aktiviert ist, 
leuchten die Record Enable-Schaltflächen blau.

Erstellen Sie Spurengruppen für jeden Spur-
Stem oder -Satz, auf dem Sie Punch-Vorgänge 
ausführen möchten. Mithilfe der Groups-Liste 
können Sie dann schnell alle Spuren in der 
Gruppe auswählen. 
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Anzeige für den Aufnahmestatus von Spuren

Die Record Enable-Schaltfläche einer jeden Spur 
zeigt den TrackPunch- und Scharfschaltungsstatus 
wie folgt an:

• Wenn für eine Spur der TrackPunch-Modus, 
jedoch nicht die Scharfschaltung aktiviert ist, 
leuchtet die entsprechende Record Enable-
Schaltfläche blau. 

• Wenn für eine Spur sowohl der TrackPunch-
Modus als auch die Scharfschaltung aktiviert ist, 
blinkt die entsprechende Record Enable-
Schaltfläche blau und rot. 

• Wenn eine Spur nur scharfgeschaltet ist, blinkt 
die entsprechende Record Enable-Schaltfläche 
rot. 

• Während der Aufnahme auf einer Spur leuchtet 
die entsprechende Record Enable-Schaltfläche 
rot (in allen Aufnahmemodi).

Monitoring und Pegel

So führen Sie das Setup für TrackPunch durch: 

1 Konfigurieren Sie das Monitoring von 
scharfgeschalteten Spuren, indem Sie im Track-
Menü den gewünschten Modus auswählen oder 
auf die TrackInput-Schaltfläche klicken. Es 
stehen folgende Möglichkeiten zur Auswahl:

• Set Record Tracks to Auto Input 

• Set Record Tracks to Input Only 

Die Auswahl eines Monitor-Modus wirkt sich nur 
auf scharfgeschaltete Spuren aus. 

2 Starten Sie die Wiedergabe und vergleichen Sie 
die Pegel der Eingangsquelle mit Audiomaterial 
auf dem Datenträger. Klicken Sie auf die 
TrackInput-Schaltfläche, um die Spurquelle zu 
wechseln. Wenn sie aufleuchtet (grün), hört die 
Spur den Eingang ab. Wenn sie nicht leuchtet 
(grau), hört die Spur von der Festplatte ab (siehe 
„Auswählen von Record Monitor-Modi mit 
TrackInput-Monitoring“ auf Seite 449). 

3 Wenn Sie mit den Pegeln zufrieden sind, 
können Sie die Punch-Aufnahme starten. 

Record Enable-Schaltfläche aktiviert

Rot (permanent leuchtend) zeigt an, dass 
aufgenommen wird (gilt für alle Modi)
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Verwenden von TrackPunch
Nach der Konfiguration von Pro Tools, Spuren 
und Pegeln haben Sie verschiedene 
Möglichkeiten, mit TrackPunch aufzunehmen. 

Punch-Ins auf einzelnen Spuren

So führen Sie Punch-Ins auf einzelnen Spuren 
durch:

1 Stellen Sie sicher, dass sich Pro Tools im 
TrackPunch-Modus befindet.

2 Klicken Sie bei gedrückter Ctrl-Taste (Mac) 
oder Windows-Taste (Windows) auf die Record 
Enable-Schaltfläche der Spur, auf der Sie 
Punch-Ins ausführen möchten, sodass für diese 
Spur nur der TrackPunch-Modus aktiviert ist. 
Die Record Enable-Schaltfläche dieser Spur 
sollte nun blau leuchten. 

3 Klicken Sie im Transport-Fenster auf die 
Record-Schaltfläche, um die Spur in den 
Record Ready-Modus mit TrackPunch zu 
versetzen. Die Record-Schaltfläche blinkt blau 
und rot.

4 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

5 Während der Wiedergabe führen Sie auf der 
Spur, für die der TrackPunch-Modus aktiviert 
ist, Punch-Ins und Punch-Outs aus, indem Sie 
auf deren Record Enable-Schaltfläche klicken. 

6 Führen Sie während der lokalen oder entfernten 
Wiedergabe einen der folgenden Vorgänge aus:

• Führen Sie einen Punch-In-Vorgang auf 
weiteren einzelnen Spuren im TrackPunch-
Modus durch.

• Heben Sie nach dem Punch-Out die 
Scharfschaltung einiger Spuren auf und schalten 
Sie andere Spuren im TrackPunch-Modus 
scharf. 

• Wiederholen Sie diesen Vorgang so oft wie nötig 
für weitere Stems, Spuren oder Takes. 

7 Halten Sie die Wiedergabe an. Wenn der 
Aufnahmedurchgang abgeschlossen ist, 
entsprechen der Record Enable-Status der Spur 
und der Record Arm-Status des Transports den 
aktuellen Einstellungen für Audio Track 

RecordLock und Transport RecordLock. 

Nach einem TrackPunch-Aufnahmedurchgang 
werden im Edit-Fenster in der Playlist der Punch-
Spur die beim Punch-Vorgang erzeugten Clips 
angezeigt. Sie können nach der Punch-Aufnahme 
alle Trim-Werkzeuge verwenden, um den 
Spuranfang oder das Spurende der mit TrackPunch 
aufgenommenen Clips zu öffnen oder um die 
übergeordnete Audiodatei anzuzeigen, die im 
Hintergrund aufgenommen wurde. Auf diese 
Weise können Sie zu spät oder überhaupt nicht 
ausgeführte Punches ausgleichen. 

Informationen zur Benennung von Dateien und 
Clips finden Sie unter „Audiodateien, Clips und 
Takes“ auf Seite 502. 
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Punch-Ins auf mehreren Spuren 
gleichzeitig

So führen Sie Punch-Ins auf mehreren Spuren 
gleichzeitig durch:

1 Aktivieren Sie den TrackPunch-Modus. 

2 Klicken Sie auf die Record Enable-Schaltfläche 
der Spuren, auf denen Sie Punch-Ins ausführen 
möchten, sodass für diese Spuren sowohl der 
TrackPunch-Modus als auch die 
Scharfschaltung aktiviert ist. Die Record 
Enable-Schaltflächen dieser Spuren blinken 
nun blau und rot.

3 Sie haben folgende Möglichkeiten: 

• Klicken Sie während der Wiedergabe auf die 
Record-Schaltfläche im Transport-Fenster, um 
auf allen Spuren, für die der TrackPunch-Modus 
aktiviert wurde, gleichzeitig Punch-In- und 
Punch-Out-Vorgänge auszuführen. 

• Klicken Sie zuerst im Transport-Fenster auf die 
Record-Schaltfläche. Halten Sie dann Wahl + 
Umschalt (Mac) bzw. Alt + Umschalt 
(Windows) gedrückt und klicken Sie auf die 
Record Enable-Schaltfläche einer Spur, um 
gleichzeitig Punch-In- und Punch-Out-
Vorgänge auf allen aktuell ausgewählten Spuren 
auszuführen, für die der TrackPunch-Modus 
aktiviert ist.

4 Halten Sie die Wiedergabe an. Wenn der 
Aufnahmedurchgang abgeschlossen ist, 
entsprechen der Record Enable-Status der Spur 
und der Record Arm-Status des Transports den 
aktuellen Einstellungen für Audio Track 

RecordLock und Transport RecordLock. 

Beginnen der Aufnahme auf 
allen Spuren
Sie können wählen, einen Punch-Durchgang bei 
der Aufnahme zu starten, Punch-Out- und dann 
erneute Punch-In-Vorgänge bei Bedarf 
auszuführen. 

So führen Sie Punch-Ins auf allen Spuren aus:

1 Aktivieren Sie den TrackPunch-Modus 
(siehe „Anzeige des TrackPunch-Status im 
Transport-Bereich“ auf Seite 507).

2 Klicken Sie auf die Record Enable-Schaltfläche 
der Spuren, auf denen Sie Punch-Ins ausführen 
möchten, sodass für diese Spuren sowohl der 
TrackPunch-Modus als auch die 
Scharfschaltung aktiviert ist. Die Record 
Enable-Schaltflächen dieser Spuren blinken 
nun blau und rot. 

3 Klicken Sie im Transport-Fenster auf die 
Record-Schaltfläche, um die Spur in den 
Record Ready-Modus mit TrackPunch zu 
versetzen. Die Record-Schaltfläche blinkt blau 
und rot.

4 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

5 Während der Wiedergabe führen Sie auf 
einzelnen Spuren, für die der TrackPunch-
Modus aktiviert ist, Punch-Out und dann erneut 
Punch-In aus, indem Sie auf die Record Enable-
Schaltflächen der jeweiligen Spur klicken.

6 Halten Sie die Wiedergabe an. Wenn der 
Aufnahmedurchgang abgeschlossen ist, 
entsprechen der Record Enable-Status der Spur 
und der Record Arm-Status des Transports den 
aktuellen Einstellungen für Audio Track 

RecordLock und Transport RecordLock. 
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DestructivePunch-
Audioaufnahme
(Nur Pro Tools HD)

DestructivePunch ist ein destruktiver 
Aufnahmemodus, der Punch-In- und Punch-Out-
Vorgänge während der Wiedergabe ermöglicht, 
während gleichzeitig eine kontinuierliche Audiodatei 
auf jeder Spur, auf der ein Punch-Vorgang 
ausgeführt wurde, gespeichert wird. Wie auch beim 
TrackPunch-Modus können Sie beim 
DestructivePunch-Modus Punch-In- und Punch-Out-
Vorgänge für jeweils einzelne Spuren oder auch für 
mehrere Spuren gleichzeitig ausführen. 

Anders als der QuickPunch- und der TrackPunch-
Modus ersetzt der DestructivePunch-Modus 
Audiomaterial innerhalb der übergeordneten 
Zieldatei. Der DestructivePunch-Modus ist 
letztendlich eine destruktive Version des 
TrackPunch-Modus. Im TrackPunch-Modus wird 
Audiomaterial immer in einer neuen Datei im 
Hintergrund aufgenommen. Im DestructivePunch-
Modus dagegen wird Audiomaterial direkt in die 
Ursprungsdatei aufgenommen, unter Verwendung 
eines festen linearen 10-Millisekunden-
Crossfades. Während der Aufnahme im 
DestructivePunch-Modus werden keine weiteren 
Clips erstellt. Bis zu 200 „Running Punches“ 
können in einer Spur während eines einzigen 
DestructivePunch-Durchgangs ausgeführt werden.

DestructivePunch-Setup
(Nur Pro Tools HD)

Vor der Verwendung von DestructivePunch in einem 
Aufnahmedurchgang müssen Sie die Pro Tools-, 
Session- und Spureinstellungen konfigurieren. 

Konfigurieren von Pro Tools für 
DestructivePunch

So konfigurieren Sie Pro Tools: 

1 Konfigurieren Sie Spur-, Voice- und andere 
Einstellungen nach Bedarf (siehe „Richtlinien 
für die Punch-Aufnahme“ auf Seite 500). 

2 Stellen Sie sicher, dass Pro Tools gerade keine 
Aufnahme oder Wiedergabe ausführt, d. h. der 
Transport angehalten ist. 

Aktivieren des 
DestructivePunch-Modus

So aktivieren Sie den DestructivePunch-Modus:

 Sie haben folgende Möglichkeiten:

• Wählen Sie Options > DestructivePunch.

• Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Record-Schaltfläche 
und wählen Sie DestructivePunch.

• Halten Sie die Ctrl-Taste (Mac) bzw. Windows-
Taste (Windows) gedrückt und klicken Sie im 
Transport-Fenster auf die Record-Schaltfläche. 
Blättern Sie so durch die verfügbaren 
Aufnahmemodi, bis der DestructivePunch-
Modus mit einem „DP“ angezeigt wird. 

DestructivePunch-Aufnahmen werden 
bei mit AudioSuite gerenderten Clips 
mit Handles nicht unterstützt. Sie können 
solche Clips konsolidieren, wenn Sie 
den DestructivePunch-Modus 
verwenden müssen.

Die Power-Waveform-Darstellung ist im 
DestructivePunch-Modus nicht verfügbar.
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Anzeige des DestructivePunch-Status 
im Transport-Fenster

Bei aktiviertem DestructivePunch-Modus:

 Auf der Record-Schaltfläche im Transport-
Fenster wird „DP“ angezeigt. 

 Wenn für mindestens eine Spur der 
DestructivePunch-Modus aktiviert ist, leuchtet die 
Record-Schaltfläche im Transport-Fenster blau.

Bei aktiviertem DestructivePunch-Modus und für 
die Aufnahme scharfgeschaltetem Transport:

 Wenn für keine Spur der DestructivePunch-
Modus aktiviert ist, blinkt die Record-Schaltfläche 
im Transport-Fenster grau und rot. 

 Wenn für mindestens eine Spur der 
DestructivePunch-Modus aktiviert ist, blinkt die 
Record-Schaltfläche im Transport-Fenster blau 
und rot.

 Wenn für mindestens eine Spur der 
DestructivePunch-Modus und zugleich die 
Scharfschaltung aktiviert ist, blinkt die Record-
Schaltfläche blau und rot und die Aufnahme-LED 
leuchtet.

 Wenn auf mindestens einer Audiospur 
aufgenommen wird, leuchtet die Record-
Schaltfläche rot.

Vorbereiten von Spuren für die 
Aufnahme im DestructivePunch-
Modus
Damit eine Spur für die Aufnahme im 
DestructivePunch-Modus aktiviert wird, muss die 
Spur eine kontinuierliche Audiodatei enthalten, 
die folgende Anforderungen erfüllt:

• Die Datei muss am Anfang (Sample 0) der 
Session beginnen. 

• Die Dateilänge muss mindestens der Einstellung 
für „DestructivePunch File Length“ entsprechen 
(siehe „Dateilänge für DestructivePunch“ auf 
Seite 513). 

Wenn eine Spur keine Datei enthält, die diese 
Bedingungen erfüllt, haben Sie folgende 
Möglichkeiten, die Anforderungen zu erfüllen:

• Verschieben Sie die aktuelle Datei in der Spur-
Timeline, sodass der Beginn der Datei mit dem 
Start der Session übereinstimmt.

• Erstellen Sie mithilfe des Consolidate-Befehls 
eine kontinuierliche Datei mit der erforderlichen 
Länge.

• Ändern Sie die Einstellung für 
„DestructivePunch File Length“, sodass die 
aktuelle Datei der erforderlichen Länge 
entspricht oder größer ist.

• Konsolidieren Sie mithilfe des Prepare DPE 
Tracks-Befehls Audiomaterial auf allen Spuren, 
für die der DestructivePunch-Modus aktiviert 
ist. (Siehe „Verwenden des Prepare DPE Tracks-
Befehls“ auf Seite 514.)

Dateilänge für DestructivePunch

Damit DestructivePunch auf einer Audiospur 
verwendet werden kann, muss die Spur eine 
kontinuierliche Audiodatei mit einer Mindestlänge 
enthalten, die auf der Operation Preferences-
Registerkarte von Pro Tools festgelegt ist.

So legen Sie die DestructivePunch-Dateilänge 
fest:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte. 

2 Geben Sie einen Wert für DestructivePunch File 

Length ein. 

3 Klicken Sie auf OK.

Transport Record Enable-Schaltfläche bei aktiviertem 
DestructivePunch-Modus
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Verwenden des Prepare DPE Tracks-
Befehls

So bereiten Sie eine Spur für die Aufnahme im 
DestructivePunch-Modus vor:

1 Aktivieren Sie den DestructivePunch-Modus 
(siehe „Aktivieren des DestructivePunch-
Modus“ auf Seite 512). 

2 Stellen Sie sicher, dass für die Spuren, die Sie 
vorbereiten möchten, der DestructivePunch-
Modus aktiviert ist (siehe „Aktivieren des 
DestructivePunch-Modus für Spuren ohne 
gleichzeitige Scharfschaltung“ auf Seite 514).

3 Wählen Sie Options > Prepare DPE Tracks. 

Pro Tools konsolidiert Audiomaterial auf allen 
Spuren, für die der DestructivePunch-Modus 
aktiviert ist, zu Beginn der Session auf den in der 
Voreinstellung DestructivePunch File Length 
festgelegten Wert. 

Aktivieren von Spuren für die 
Aufnahme im DestructivePunch-
Modus
Sie können für Spuren den DestructivePunch-
Modus aktivieren, ohne sie scharfzuschalten. So 
können Sie jederzeit nach Beginn der Wiedergabe 
für einzelne Spuren Punch-In-Vorgänge 
ausführen, indem Sie auf die entsprechenden 
Record Enable-Schaltflächen klicken. 

Sie können auch gleichzeitig den 
DestructivePunch-Modus für Spuren aktivieren 
und die Spuren scharfschalten. So kann die 
Aufnahme beginnen, sobald der Transport 

scharfgeschaltet ist und die Wiedergabe beginnt. 
(Siehe „Gleichzeitiges Aktivieren von Spuren für 
DestructivePunch und Scharfschalten“ auf 
Seite 515.)

Aktivieren des DestructivePunch-
Modus für Spuren ohne gleichzeitige 
Scharfschaltung

Bei dieser Methode können Sie den Prepare DPE 

Tracks-Befehl verwenden, um Dateien für die 
DestructivePunch-Aufnahme zu konsolidieren. 

So aktivieren Sie den DestructivePunch-Modus für 
eine Audiospur:

 Klicken Sie bei gedrückter Ctrl-Taste (Mac) 
oder Windows-Taste (Windows) auf die 
Record Enable-Schaltfläche der Spur. Die 
Schaltfläche wird nun blau dargestellt.

So aktivieren Sie den DestructivePunch-Modus für 
alle Audiospuren: 

 Drücken Sie Wahl + Ctrl (Mac) bzw. 
Windows + Alt (Windows) und klicken Sie auf 
die Record Enable-Schaltfläche einer Spur. Alle 
Record Enable-Schaltflächen werden nun blau 
dargestellt.

So aktivieren Sie den DestructivePunch-Modus für 
alle ausgewählten Audiospuren:

 Drücken Sie Wahl + Ctrl + Umschalt (Mac) 
bzw. Windows + Alt + Umschalt (Windows) 
und klicken Sie auf die Record Enable-
Schaltfläche einer Spur. Die Record Enable-
Schaltflächen für alle ausgewählten 
Audiospuren werden nun blau dargestellt.

Bei Clips, die nicht 0 dB als Clip-Gain 
eingestellt haben, rendert der Befehl 
„Prepare DPE-Tracks“ den Clip-Gain 
automatisch und setzt alle Clip-Gain-
Einstellungen auf 0 dB zurück.

Erstellen Sie eine VCA-Gruppe für jeden 
Spur-Stem oder -Satz, für den Sie einen 
Punch-Vorgang planen. Verwenden Sie die 
VCA Record Enable-Schaltfläche, um für alle 
Spuren in der Gruppe DestructivePunch zu 
aktivieren. Weitere Informationen finden Sie 
unter „VCA Master-Spuren“ auf Seite 985.
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Gleichzeitiges Aktivieren von Spuren 
für DestructivePunch und 
Scharfschalten

Diese Methode kann verwendet werden, wenn 
Spuren bereits die Anforderungen für die 
Aufnahme im DestructivePunch-Modus erfüllen.

So aktivieren Sie den DestructivePunch-Modus für 
Spuren und schalten diese gleichzeitig scharf:

 Klicken Sie auf die Scharfschalten-Schaltfläche 
der Spur. Die Record Enable-Schaltflächen 
dieser Spuren blinken nun blau und rot. 

So aktivieren Sie den DestructivePunch-Modus für 
alle Audiospuren und schalten diese gleichzeitig 
scharf:

 Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die Record 
Enable-Schaltfläche der Spur. Die Record 
Enable-Schaltflächen aller Spuren blinken blau 
und rot.

So aktivieren Sie den DestructivePunch-Modus für 
alle ausgewählten Audiospuren und schalten 
diese gleichzeitig scharf:

 Drücken Sie Wahl + Umschalt (Mac) bzw. 
Alt + Umschalt (Windows) und klicken Sie auf 
die Record Enable-Schaltfläche einer Spur. Die 
Record Enable-Schaltflächen für die 
ausgewählten Audiospuren blinken blau 
und rot.

Anzeige für den Aufnahmestatus von 
Spuren

Wenn sich Pro Tools im DestructivePunch-Modus 
befindet, zeigt die Record Enable-Schaltfläche 
einer jeden Spur ihren DestructivePunch- und 
Scharfschaltungsstatus folgendermaßen an:

• Wenn für eine Spur sowohl der 
DestructivePunch-Modus als auch die 
Scharfschaltung aktiviert ist, blinkt die 
entsprechende Record Enable-Schaltfläche blau 
und rot. 

• Wenn für eine Spur der DestructivePunch-
Modus, jedoch nicht die Scharfschaltung 
aktiviert ist, leuchtet die entsprechende Record 
Enable-Schaltfläche blau. 

• Wenn eine Spur nur scharfgeschaltet ist, blinkt 
die entsprechende Record Enable-Schaltfläche 
rot.

• Während der Aufnahme auf einer Spur leuchtet 
die entsprechende Record Enable-Schaltfläche 
rot (in allen Aufnahmemodi).
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Monitoring und Pegel

So führen Sie das Setup für DestructivePunch 
durch: 

1 Konfigurieren Sie das Monitoring von 
scharfgeschalteten Spuren, indem Sie im Track-
Menü den gewünschten Modus auswählen. Es 
stehen folgende Möglichkeiten zur Auswahl:

• Set Record Tracks to Auto Input 

• Set Record Tracks to Input Only 

Die Auswahl eines Monitor-Modus wirkt sich nur 
auf scharfgeschaltete Spuren aus. 

2 Starten Sie die Wiedergabe. 

3 Um die Pegel der Eingangsquelle mit 
Audiomaterial auf dem Datenträger zu 
vergleichen, klicken Sie auf die TrackInput-
Schaltfläche der Spur. Wenn sie aufleuchtet 
(grün), hört die Spur den Eingang ab. Wenn sie 
nicht leuchtet (grau), hört die Spur von der 
Festplatte ab (siehe „Auswählen von Record 
Monitor-Modi mit TrackInput-Monitoring“ auf 
Seite 449). 

Wenn Sie mit den Pegeln zufrieden sind, können 
Sie die Punch-Aufnahme starten. 

Verwenden von 
DestructivePunch 
Nach der Konfiguration von Pro Tools, 
Spuren und Pegeln haben Sie verschiedene 
Möglichkeiten, DestructivePunch für die 
Aufnahme zu verwenden.

Punch-Ins auf einzelnen Spuren

So führen Sie Punch-Ins auf einzelnen Spuren 
durch:

1 Aktivieren Sie den DestructivePunch-Modus 
(siehe „Aktivieren des DestructivePunch-
Modus“ auf Seite 512). 

2 Klicken Sie bei gedrückter Ctrl-Taste (Mac) 
oder Windows-Taste (Windows) auf die Record 
Enable-Schaltfläche der Spur, auf der Sie 
Punch-Ins ausführen möchten, sodass für diese 
Spur nur der DestructivePunch-Modus aktiviert 
ist. Die Record Enable-Schaltfläche dieser Spur 
leuchtet nun blau. 

3 Klicken Sie im Transport-Fenster auf „Record“, 
um die Spur in den Record Ready-Modus zu 
versetzen. Die Record Enable-Schaltfläche 
blinkt blau und rot.

4 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

5 Während der Wiedergabe führen Sie 
auf einzelnen Spuren, für die der 
DestructivePunch-Modus aktiviert ist, Punch-
In- und Punch-Out-Vorgänge aus, indem Sie auf 
die Record Enable-Schaltflächen der jeweiligen 
Spuren klicken.

6 Halten Sie die Wiedergabe an. Wenn der 
Aufnahmedurchgang abgeschlossen ist, 
entsprechen der Record Enable-Status der Spur 
und der Record Arm-Status des Transports den 
aktuellen Einstellungen für Audio Track 

RecordLock und Transport RecordLock. 
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Punch-Ins auf mehreren Spuren

So führen Sie Punch-Ins auf mehreren Spuren 
gleichzeitig durch:

1 Aktivieren Sie den DestructivePunch-Modus 
(siehe „Aktivieren des DestructivePunch-
Modus“ auf Seite 512). 

2 Klicken Sie auf die Record Enable-Schaltfläche 
der Spuren, auf denen Sie Punch-In-Vorgänge 
ausführen möchten, sodass für diese Spuren 
sowohl der DestructivePunch-Modus als auch 
die Scharfschaltung aktiviert sind. Die Record 
Enable-Schaltflächen aller Spuren blinken nun 
blau und rot. 

3 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

4 Klicken Sie während der Wiedergabe im 
Transport-Fenster auf die Record-Schaltfläche, 
um auf allen Spuren, für die der 
DestructivePunch-Modus aktiviert wurde, 
gleichzeitig Punch-In- und Punch-Out-
Vorgänge auszuführen. 

5 Halten Sie die Wiedergabe an. Wenn der 
Aufnahmedurchgang abgeschlossen ist, 
entsprechen der Record Enable-Status der Spur 
und der Record Arm-Status des Transports den 
aktuellen Einstellungen für Audio Track 

RecordLock und Transport RecordLock.

Sofortiges Starten der 
Aufnahme auf mehreren Spuren

So führen Sie Punch-Ins auf mehreren Spuren 
durch:

1 Aktivieren Sie den DestructivePunch-Modus 
(siehe „Aktivieren des DestructivePunch-
Modus“ auf Seite 512). 

2 Klicken Sie auf die Record Enable-Schaltfläche 
der Spuren, auf denen Sie Punch-In-Vorgänge 
ausführen möchten, sodass für diese Spuren 
sowohl der DestructivePunch-Modus als auch 
die Scharfschaltung aktiviert sind. Die Record 
Enable-Schaltflächen aller Spuren blinken nun 
blau und rot. 

3 Klicken Sie im Transport-Fenster auf „Record“, 
um die Spur in den Record Ready-Modus zu 
versetzen. Die Record-Schaltfläche blinkt blau 
und rot.

4 Klicken Sie im Transport-Fenster auf „Play“, 
um die Wiedergabe zu starten.

5 Während der Wiedergabe führen Sie auf 
einzelnen Spuren, für die der 
DestructivePunch-Modus aktiviert ist, Punch-
Out- und dann erneut Punch-In-Vorgänge aus, 
indem Sie auf die Record Enable-Schaltflächen 
der jeweiligen Spuren klicken.

6 Halten Sie die Wiedergabe an. Wenn der 
Aufnahmedurchgang abgeschlossen ist, 
entsprechen der Record Enable-Status der Spur 
und der Record Arm-Status des Transports den 
aktuellen Einstellungen für Audio Track 

RecordLock und Transport RecordLock. 
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Beispiele für TrackPunch- 
und DestructivePunch-
Workflows
Im TrackPunch- und DestructivePunch-Modus 
können Sie die Punch-Aufnahme in Pro Tools auf 
verschiedene Arten verwenden. Im 
DestructivePunch-Modus kann Pro Tools 
beispielsweise auch als Digital Dubber für die 
Filmneuaufnahme (Synchronisation) und das 
Mischen eingesetzt werden (siehe 
„Synchronisation und Mischen von Film“ auf 
Seite 518). 

Tastenkombinationen und Voreinstellungen für 
Aufnahme und Eingangs-Monitoring bieten 
Flexibilität, weshalb sich TrackPunch- und 
DestructivePunch-Modus gleichermaßen für die 
folgenden Workflows eignen, die häufig bei Film-, 
Video- und Musikproduktionen durchgeführt 
werden:

• Laden von Dailys (siehe „Laden von Dailys mit 
RecordLock“ auf Seite 519)

• Foley-Aufnahme (siehe „Foley-Aufnahme“ auf 
Seite 520)

• Tracking und Overdubbing bei der 
Musikproduktion und in anderen 
Aufnahmesituationen (siehe „Tracking und 
Overdubbing von Musik“ auf Seite 520)

Dank der Netzwerkfunktionen von Pro Tools 
lassen TrackPunch-Audiodateien (und alle 
anderen Audiodateien) und ganze Sessions sich 
auf andere Systeme übertragen, um sie dort zu 
überprüfen, zu editieren und zu archivieren. 

Synchronisation und Mischen 
von Film 
Mit den Dub- und Mischfunktionen von 
TrackPunch und DestructivePunch können Sie 
Folgendes ausführen:

• Pro Tools-Audiospuren von einem Master-
Synchronizer (etwa SoundMaster) aus über P2-
Befehle jederzeit entfernt scharfschalten und 
eine Punch-Aufnahme durchführen, ohne dabei 
die Wiedergabe anhalten oder den eingelockten 
Timecode aufheben zu müssen. (Dafür ist die 
MachineControl-Option erforderlich.)

• Pro Tools-Audiospuren zwischen Eingangs- und 
Datenträger-Monitoring umschalten. 

• Pro Tools als Timecode-Master (für die 
Generierung) oder im Slave-Modus verwenden. 

• Punch-Vorgänge nicht destruktiv im 
TrackPunch-Modus oder destruktiv im 
DestructivePunch-Modus ausführen. 

Eine Pre-Dub-Session umfasst üblicherweise die 
folgenden Schritte:

1 Konfigurieren Sie die Synchronisation 
zwischen Pro Tools und eventuell 
erforderlichen anderen Geräten. 

2 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

3 Aktivieren Sie Transport RecordLock. 
Dadurch bleibt die Record-Schaltfläche 
im Transport-Bereich nach dem Ende des 
Transports aktiviert.

Falls Sie noch nicht mit dem Routing, 
Selektieren und Gruppieren von Pro Tools-
Spuren vertraut sind, finden Sie 
Informationen unter Kapitel 13: „Spuren“ 
und Kapitel 43: „Einfaches Mixen“.

Die in diesen Beispielen enthaltenen 
Verweise auf TrackPunch gelten genauso für 
DestructivePunch – denken Sie einfach 
daran, dass es sich bei TrackPunch um einen 
nicht destruktiven, bei DestructivePunch 
dagegen um einen destruktiven Punch-Modus 
handelt. 
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4 Deaktivieren Sie Audio Track RecordLock. 
Dadurch wird die Record-Schaltfläche der 
einzelnen Spuren nach Ende des Transports 
deaktiviert.

5 Sie haben folgende Möglichkeiten: 

• Wählen Sie Options > TrackPunch, um den 
TrackPunch-Modus für nicht destruktive Punch-
Aufnahmen zu aktivieren. 

• Wählen Sie Options > DestructivePunch, um 
den DestructivePunch-Modus für die Aufnahme 
zu aktivieren. 

6 Erstellen Sie 32 neue Spuren.

7 Weisen Sie die Spureingänge zu.

8 Sortieren Sie die Spuren in Gruppen zu je acht 
Spuren. 

9 Klicken Sie auf die Record Enable-
Schaltflächen der ersten acht Spuren, um diese 
(oder die Gruppe für den ersten Pre-Dub) 
scharfzuschalten.

10 Weisen Sie die Paddles des Mischpults der 
ersten Gruppe mit acht Spuren in der Session 
zu. 

11 Beginnen Sie mit dem Pre-Dub-Durchgang. 
Verwenden Sie die Paddles des Mischpults, um 
Pro Tools zu aktivieren und den Punch-In- und 
Punch-Out-Vorgang an der ersten Gruppe 
durchzuführen. 

12 Löschen Sie am Ende des ersten Pre-Dubs, 
nachdem der Punch-Out-Vorgang für alle 
Spuren abgeschlossen ist, alle Spuren im 
TrackPunch- oder DestructivePunch-Modus.

13 Wählen Sie die nächste Spurengruppe aus und 
aktivieren Sie den TrackPunch- oder 
DestructivePunch-Modus.

14 Führen Sie Punch-In und Punch-Out an der 
zweiten Gruppe durch. 

15 Wiederholen Sie die vorhergehenden Schritte 
bei Bedarf.

Laden von Dailys mit 
RecordLock
Dailys und ähnliche Übertragungstypen bestehen 
aus mehreren Szenen oder Takes, die alle mit 
einem eingelockten eindeutigen Timecode mit der 
Tagesuhrzeit aufgenommen wurden. Zwischen 
den Takes läuft Timecode nicht weiter, sondern 
hält vollständig an. Aus diesem Grund ist der 
Timecode bei Dailys und ähnlichem 
Ausgangsmaterial nicht durchgängig. 

Standardmäßig bricht Pro Tools die Aufnahme ab, 
wenn es aufgrund eines nicht durchgängigen 
Timecodes offline geschaltet wird. Sie können 
dieses Verhalten jedoch ändern, sodass Pro Tools 
stattdessen weiterhin scharfgeschaltet bleibt und 
auf das erneute Starten der Aufnahme wartet, 
wenn die Sperrung mit dem Timecode des 
nächsten Takes wiederhergestellt wird. 

Im Remote-Modus hat „Transport 
RecordLock“ keinen Effekt. Das Verhalten 
wird vom Synchronizer bestimmt.

Im Remote-Modus hat „Audio Track 
RecordLock“ keinen Effekt. Das Verhalten 
wird vom Synchronizer bestimmt.

Mithilfe der Groups-Liste können Sie schnell 
alle Spuren in der Gruppe auswählen und 
durch Klicken bei gedrückter Alt- und 
Umschalttaste (Windows) bzw. Wahl- und 
Umschalttaste (Mac) scharfschalten.
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So konfigurieren Sie RecordLock zum Laden:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte. 

2 Aktivieren Sie Transport RecordLock. 

3 Aktivieren Sie Audio Track RecordLock. 

4 Konfigurieren Sie die Synchronisation und 
andere Einstellungen wie gewünscht. 

5 Schalten Sie Pro Tools online und starten Sie 
das externe Abspielgerät. 

6 Wenn der Timecode ausfällt oder unterbrochen 
wird, bleibt Pro Tools online und wartet auf den 
nächsten Timecode. Die für den Transport 
aktivierten und scharfgeschalteten Spuren 
bleiben scharfgeschaltet. Wenn der Timecode 
wieder aufgenommen wird, beginnt Pro Tools 
mit der Aufnahme in einer neuen Audiodatei 
(mit dem korrekten Zeitstempel auf Grundlage 
des eingehenden Timecodes). 

Foley-Aufnahme 
Die Foley-Aufnahme ist einer der aufwendigeren 
Aufnahmevorgänge bei der Filmproduktion und 
erfordert besondere Monitoring-Techniken. 
Zwischen den Punches und den Takes müssen die 
Eingänge stummgeschaltet werden, während 
Geräuschemacher bei der Postproduktion einer 
Szene sich und ihre Ausrüstung auf die nächste 
Aufnahme vorbereiten. 

Die TrackInput-Abhörfunktion kann so 
konfiguriert werden, dass für die TrackPunch-
Aufnahme beim Erzeugen von Geräuschen die 
Voreinstellung Mute Record-Armed Tracks While 

Stopped verwendet wird.

So konfigurieren Sie Pro Tools für das Punch-
Aufnahme-Monitoring bei der Foley-Aufnahme: 

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Aktivieren Sie Mute Record-Armed Tracks 

While Stopped.

3 Konfigurieren Sie die Synchronisation und 
andere Einstellungen für Pro Tools und Ihre 
anderen Geräte. 

4 Aktivieren Sie den TrackPunch- oder 
DestructivePunch-Modus und fahren Sie mit 
der Punch-Aufnahme fort. 

Wenn die Aufnahme online durchgeführt wird und 
Mute Record-Armed Tracks While Stopped 
aktiviert ist, werden scharfgeschaltete Spuren 
stummgeschaltet, wenn der Transport angehalten 
wird. Der Eingang kann weiterhin jederzeit über 
die TrackInput-Schaltfläche der Spur abgehört 
werden. 

Tracking und Overdubbing von 
Musik 
Die moderne Multitrack-Aufnahme erfordert hohe 
Flexibilität beim Erfassen des „richtigen“ 
Moments. Dazu sind die von TrackPunch 
bereitgestellten Funktionen für die On-the-Fly-
Scharfschaltung und -Punch-Aufnahme 
erforderlich. Zu den TrackPunch-Funktionen für 
Tracking, Overdubbing und Punching gehören 
folgende:

• Spuren scharfstellen, während der Transport 
läuft 

• Punch-In und Punch-Out von Spuren durch 
Fernbedienen der Record Enable-Schaltflächen 
auf dem Bildschirm von einem Synchronizer, 
einer Bedienoberfläche oder einem Fußschalter 
aus 

• Vergleichen und Anpassen von Pegeln mithilfe 
der TrackInput-Umschaltung 

Da die Timeline in Pro Tools auf 24 Stunden 
begrenzt ist, müssen längere Dailys in 
mehreren Sessions geladen werden.



Teil V: Editing
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Kapitel 24: Grundlagen des Editierens

Mithilfe des Edit-Fensters in Pro Tools können Sie 
Audio-, Video- und MIDI-Dateien editieren und 
anordnen. Das Spurmaterial kann während der 
Wiedergabe nichtdestruktiv und in Echtzeit 
editiert werden. 

Außerdem können Sie im Edit-Fenster andere 
Daten grafisch bearbeiten wie folgt:

Editieren von Clips und Selektionen. Siehe 
Kapitel 27: „Editieren von Clips und Selektionen“. 
Siehe auch Kapitel 37: „Anordnen von Clips“.

Editieren von Fades und Crossfades. Siehe 
Kapitel 28: „Fades und Crossfades“.

Editieren von Elastic Audio. Siehe Kapitel 40: 
„Elastic Audio“.

Editieren von MIDI. Siehe Kapitel 31: „Editieren 
von MIDI-Daten“. 

Editieren von Automationsdaten. Siehe 
Kapitel 45: „Automation“.

Editieren von Video. Siehe Kapitel 52: „Video in 
Pro Tools“.

Nichtdestruktives Editieren
In Pro Tools geschieht das Editieren von Audio 
größtenteils nicht destruktiv. Unabhängig davon, 
ob Sie Clips ausschneiden, einfügen, trimmen, 
trennen oder löschen, werden diese Funktionen 
immer nur in einer Kopie der eigentlichen 
Medien (wie etwa Audiodateien) ausgeführt. 
Die ursprünglichen Dateien bleiben unverändert. 
Bestimmte Arbeitsschritte oder Tools wirken sich 
jedoch destruktiv aus (können die Audiodateien 
auf der Festplatte irreversibel ändern), wie in 
anderen Abschnitten angegeben.

Das Editieren von MIDI-Spuren kann in einigen 
Fällen destruktiv sein. Deshalb sollten Sie einige 
Vorkehrungen treffen, um wichtige MIDI-Spuren 
und -Clips während des Editierens zu sichern 
(siehe „Nichtdestruktives Editieren von MIDI“ auf 
Seite 533).
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Editieren während der 
Wiedergabe
Pro Tools ermöglicht es, Sessions auch während der 
Wiedergabe zu bearbeiten. Auf diese Weise können 
Sie eine Session interaktiv ändern und bearbeiten 
und die Veränderungen direkt mithören. 

Im Folgenden sind nur einige Beispiele für Editier- 
und Anordnungsaufgaben aufgeführt, die während 
der Wiedergabe einer Pro Tools-Session ausgeführt 
werden können:

• Erfassen, Trennen, Ausschneiden, Kopieren, 
Einfügen und Trimmen von Clips

• Platzieren, Zuordnen und Neuanordnen 
von Clips

• Hinzufügen von Fades oder Crossfades zu 
Audioclips

• Quantisieren von MIDI-Noten und Audio-Events

• Transponieren und sonstiges Ändern von 
MIDI-Spuren

• Verschieben von Audio- oder MIDI-Clips 
(Nudging)

• Abhören verschiedener Playlists

• Anpassen oder Skalieren der Automations- und 
MIDI-Continuous-Controller-Daten

• Einfügen von Echtzeit-Plug-Ins

• Anwenden von Echtzeit- (und gerenderter) 
Elastic Audio-Bearbeitung

• Verarbeiten von Audiomaterial mit einem 
AudioSuite-Plug-In

• Editieren der Automation

Es gibt einige Merkmale, die während der 
Wiedergabe mit Pro Tools nicht verändert werden 
können, so wie dies in den entsprechenden 
Abschnitten angegeben ist.

Spurmaterial
Bei jeder Aufnahme und jedem Import von Audio-, 
Video- und MIDI-Daten erstellt Pro Tools für 
die neuen Spurdaten Clips. Diese zeigen den 
Anfang und das Ende des Materials an und geben 
grafischen Aufschluss über dessen Art und Inhalt. 
Wenn Sie zusätzliche Takes aufnehmen oder an 
einer bestimmten Stelle einer Spur einen Punch-In-
Vorgang durchführen, erstellt Pro Tools weitere 
Clips.

Clips werden auch durch Ändern der Größe, 
erneutes Aufnehmen, Ausschneiden, Einfügen 
und Trennen bereits bestehender Clips erzeugt. 
Die Clips einer Session sind in der Clipliste 
aufgeführt. Von dort aus können sie auf bereits 
existierende Spuren gezogen werden. Eine Spur 
kann eine beliebige Anzahl von Clips enthalten, 
die in einer beliebigen Reihenfolge angeordnet sein 
können. Die Anordnung und Position der einzelnen 
Clips in einer Spur bestimmen ihre Playlist. 

Neben Audio- und MIDI-Clips bieten Spuren 
Automations-Playlists der Automationsdaten 
(wie Lautstärke und Pan). Automationsdaten 
können im Mix-, Edit- und MIDI Editor-
Fenster aufgenommen und bearbeitet werden 
(siehe Kapitel 45: „Automation“). 

Verwenden Sie die Loop- und Dynamic-
Transport-Modi zum Abhören und Editieren 
von Loops während der Wiedergabe. Siehe 
„Wiedergabemodi“ auf Seite 417.
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Cliparten
Je nach Art der Erstellung werden verschiedene 
Arten von Audio- und MIDI-Clips unterschieden:

Auf vollständige Dateien verweisende 
Audioclips. – diese Audioclips werden 
beim Aufnehmen und Importieren von 
Audio, Konsolidieren bestehender Clips oder 
Bearbeiten mit einem AudioSuite-Plug-In erstellt. 
Sie verweisen auf Whole-File-Audiodateien 
auf Ihrer Festplatte. Auf vollständige Dateien 
verweisende Audioclips werden in der Clipliste 
in Fettdruck angezeigt (siehe Kapitel 15: 
„Clipliste“). Gewöhnliche Clips verweisen meist 
nur auf einen Teil der übergeordneten Audiodatei 
und werden während des Editierens und 
gelegentlich bei der Punch- oder Loop-
Aufnahme erstellt. 

Benutzerdefinierte Clips. – dies sind ausdrücklich 
definierte Clips, die beim Aufnehmen oder 
Importieren von Audio- oder MIDI-Material, 
beim Erfassen, Trennen oder Zusammenfügen von 
Selektionen, beim Trimmen von auf vollständige 
Dateien verweisenden Clips und beim Umbenennen 
eines bestehenden Clips erstellt werden.

Automatisch erzeugte Clips. – diese Clips 
entstehen automatisch beim Editieren und 
gelegentlich bei der Punch-Aufnahme über 
bestehende Clips. Da sich diese Clips in einer 
Session schnell anhäufen können, können Sie 
sie in der Clipliste ausblenden. Automatisch 
erstellte Clips können durch Umbenennen in 
benutzerdefinierte Clips umgewandelt werden.

Offline-Clips. – Clips sind offline, wenn deren 
übergeordnete Dateien nicht gefunden werden 
können oder beim Öffnen einer Session bzw. 
Importieren einer Spur nicht verfügbar sind. 
Offline-Clips werden in der Clipliste kursiv und 
grau, in Playlists hellblau mit kursiv gedruckten 
Namen angezeigt. Offline-Clips können wie 
andere Clips bearbeitet werden, sie können jedoch 
nicht mit AudioSuite-Plug-Ins verarbeitet werden. 

Mehrkanal-Clips. – diese Clips werden in der 
Clipliste als ein einzelner Clip angezeigt und 
verweisen auf mehrere Clips und Audiodateien 
für Stereo- und Surround-Spuren. Sie können die 
Anzeige von Mehrkanal-Clips erweitern, indem 
Sie auf das Dreieck neben ihrem Namen klicken. 
So ist es möglich, die einzelnen Kanäle zu sehen, 
die unabhängig voneinander auf Spuren gezogen 
werden können.

Clipgruppen. – eine Clipgruppe ist eine beliebige 
Kombination aus Audio- und MIDI-Clips, die so 
aussehen und sich so verhalten wie ein einzelner 
Clip. Clipgruppen sind im Wesentlichen Container, 
die mindestens einen Clip enthalten. Sie können in 
einer einzelnen Spur oder mehreren angrenzenden 
Audio-, MIDI- und Instrumentenspuren erstellt 
werden. Mithilfe von Clipgruppen können 
Sie mehrere Clips in „Makro“-Clips für die 
Manipulation, das Editieren und Anordnen 
von Groove und Tempo „schachteln“ 
(siehe „Clipgruppen“ auf Seite 877). 

Verformte Clips. – Clips in Spuren mit Elastic 
Audio-Verarbeitung in Echtzeit, können verformt 
(warped) werden. Verformte Clips werden mit 
einem entsprechenden Symbol oben rechts in den 
Clips in Spuren und links von den Clipnamen in 
der Clipliste gekennzeichnet. Verformte Clips 
ergeben sich aus der Anwendung der Elastic Audio-
Verarbeitung. Die Elastic Audio-Verarbeitung 
kann manuell in der Warp-Darstellung oder mit 
dem TCE Trim-Tool in der Waveform-Darstellung 
angewendet werden. Sie kann aber auch 
automatisch mit dem Tempoangleich, der 
Quantisierung oder der Transposition angewendet 
werden (siehe „Gewarpte Clips“ auf Seite 923). 

Informationen zu Videoclips finden Sie 
unter Kapitel 52: „Video in Pro Tools“.

Weitere Informationen finden Sie unter 
„Benennen und Anzeigen von Clips in der 
Clipliste“ auf Seite 277. 
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Audioclips und Wellenformen
Wenn die Spurdarstellung für Audiospuren 
auf Waveform eingestellt ist, wird in Pro Tools 
ein Wellenform-Diagramm des Audiomaterials 
angezeigt. Audiowellenformen geben Aufschluss 
über die Merkmale des aufgenommenen 
Audiomaterials.

In der Abbildung oben zeigen die Spitzenwerte 
diejenigen Stellen in der Aufnahme, an denen die 
Einschwingphase (Attack) des Audiosignals die 
Lautstärke für kurze Zeit stark ansteigen lässt. 
In den folgenden „Tälern“ fällt die Lautstärke ab.

Verschiedene Soundarten erzeugen verschiedene 
Arten von Wellenformen. So ist die von einem 
Schlaginstrument erzeugte Wellenform in der Regel 
an den deutlichen und markanten Signalspitzen 
(kurz anhaltende Spitzenwerte) zu erkennen. 
Ein Trommelschlag hat eine laute und markante 
Attack-Phase und eine sehr kurze Decay-Zeit.

Andere Klänge, wie Gesang oder anhaltende 
Synthesizerstücke, erzeugen ganz andere 
Wellenformen. Diese Klänge haben weniger 
ausgeprägte Spitzen und Täler, da im Allgemeinen 
die Attack-Phasen weicher und die Decay-
Zeiten länger sind.

Waveform-Darstellungen
Pro Tools bietet mehrere verschiedene Optionen 
für Waveform-Darstellungen. Abhängig von der 
Bearbeitungsaufgabe können Sie Wellenformen 
auf unterschiedliche Arten anzeigen.

Berechnen von 
Wellenformübersichten
Wellenformen können mit den Peak- oder Power-
Übersichten berechnet werden. 

So legen Sie fest, wie die Waveform-Darstellung 
berechnet wird:

 Wählen Sie View > Waveforms und 
anschließend Peak oder Power 

Peak. – bei Auswahl dieser Option wird 
die Wellenformanzeige auf Grundlage des 
Spitzenpegels für jedes einzelne Sample 
berechnet. Die Peak-Darstellung dient in 
Pro Tools normalerweise der Berechnung der 
Wellenformübersicht und wird für normale oder 
gleichgerichtete Darstellungen verwendet. In der 
Peak-Darstellung werden Übersteuerungen in der 
Wellenform deutlich angezeigt.

Audiowellenform einer Schlagzeugspur

Normale Peak-Waveform-Darstellung mit 
Umrandungen

Beim Zoomen auf Sample-Darstellungsgröße 
wird in Pro Tools immer die Peak-
Darstellung angezeigt.
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Power. – bei Auswahl dieser Option wird die 
Wellenformanzeige gemäß RMS (Root-Mean-
Square) berechnet. Die Power-Darstellung kann 
für normale oder gleichgerichtete Darstellungen 
verwendet werden. Die Power-Darstellung ist 
hilfreich, um die Eigenschaften des Audiomaterials 
in der Wellenform besser zu sehen, wenn diese 
über die Sample-Darstellungsgröße hinaus 
herausgezoomt ist. Insbesondere bei Mastering-
Anwendungen kann sie hinsichtlich der 
Klangeigenschaften des Audiomaterials 
aussagefähiger sein als die Peak-Darstellung.

Gleichgerichtete Wellenformen
Gleichgerichtete Wellenformen werden so 
angezeigt, dass die positiven und negativen 
Ausschläge der Wellenform (die Abschnitte ober- 
bzw. unterhalb der Nulllinie) addiert und als ein 
einziges Signal mit positivem Wert dargestellt 
werden. In dieser Darstellung können Sie bei 
normaler und reduzierter Darstellungshöhe 
der Spur mehr Wellenformdetails sehen. 
Als besonders nützlich erweist sich diese Option 
bei der Bearbeitung der Daten für die Volume-
Automation, da die Wellenformpegel vom unteren 
Ende der Spur ausgehend dargestellt werden. 
Die gleichgerichtete Darstellung ist in den Peak- 
und Power-Darstellungen möglich.

So zeigen Sie Wellenformen gleichgerichtet 
(oder normal) an:

 Aktivieren (oder deaktivieren) Sie View > 

Waveforms > Rectified.

Normale Power-Waveform-Darstellung 
mit Umrandungen

Die Peak-Darstellung wird immer während der 
Aufnahme angezeigt. Die Power-Waveform-
Darstellung wird erst nach Abschluss der 
Aufnahme berechnet und angezeigt.

Die Power-Darstellung ist im 
DestructivePunch-Modus oder bei Zoom auf 
Sample-Darstellungsgröße nicht verfügbar.

Gleichgerichtete Peak-Waveform-Darstellung 
mit Umrandungen

Gleichgerichtete Power-Waveform-Darstellung 
mit Umrandungen

Beim Zoomen auf die Sample-Darstellung wird 
in Pro Tools immer die Wellenformanzeige in 
der normalen Peak-Darstellung genutzt.
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Wellenformen mit Umrandungen
Wellenformen mit Umrandungen bieten eine 
bessere grafische Definition der Wellenform, 
speziell wenn sie aus einer Entfernung betrachtet 
werden. Sie können Umrandungen jedoch 
deaktivieren, wenn Sie ein präzises, detailliertes 
Bearbeiten der Peak-Waveform-Darstellung 
ausführen müssen. Die Umrandungen werden 
nicht angezeigt, wenn auf Sample-
Darstellungsgröße gezoomt ist.

So blenden Sie Wellenformumrandungen 
ein (oder aus):

 Aktivieren (oder deaktivieren) Sie View > 

Waveforms > Outlines.

Richtlinien zum Editieren von 
Wellenformen
Mit dem Selektor-Tool im Edit-Fenster können Sie 
Teile der Audiowellenformen markieren und in 
Segmente einteilen, die als Clips bezeichnet 
werden. Clips können in Spuren angeordnet und 
editiert werden.

Versuchen Sie beim Editieren von Musikmaterial 
Clips zu erzeugen, bei denen Sie einen 
gleichmäßigen Grundschlag, also Beat, einhalten 
können. Wenn Sie Clips immer so definieren, dass 
Sie eine ganzzahlige Anzahl von Beats enthalten, 
können Sie Clips zusammenfügen und einen 
glatten, regelmäßigen Rhythmus aufrechterhalten.

In manchen Fällen ist eine deutliche und klar 
definierte Referenzwellenform (etwa die einer 
Schlagzeugspur oder einer Metronomspur) als 
Referenz für die Erstellung anderer Clips nützlich. 
Wenn Sie im Takt gespielt haben, sollte das 
Erstellen rhythmisch korrekter Clips mit Hilfe der 
Referenzwellenform wesentlich einfacher sein.

Einige wichtige Regeln für die Definition 
von Clips:

 Lassen Sie einen Clip möglichst genau vor einer 
Pegelspitze beginnen und direkt nach einer 
anderen Pegelspitze enden.

 Stellen Sie möglichst sicher, dass ein Clip 
an genau der gleichen Stelle eines Beats beginnt 
und endet.

 Verwenden Sie die folgenden Pro Tools-
Funktionen, um Rhythmusmaterial oder Audio mit 
klaren Signalspitzen in präzise Clips zu editieren:

• Zu Signalspitzen navigieren (siehe „Springen zu 
Signalspitzen“ auf Seite 587 )

• Editieren zu einem Raster (siehe „Grid-Modus“ 
auf Seite 545)

• Beat Detective (siehe Kapitel 30: „Beat 
Detective“)

Peak-Waveform-Darstellung ohne Umrandungen

Power-Waveform-Darstellung ohne Umrandungen

Gleichgerichtete Peak-Waveform-Darstellung 
ohne Umrandungen

Gleichgerichtete Power-Waveform-Darstellung 
ohne Umrandungen
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Vermeiden von Klick- und 
Knackgeräuschen
Beginnt oder endet ein Clip an einer Stelle mit 
hoher Amplitude, hören Sie bei der Wiedergabe 
mit Pro Tools unter Umständen ein Klicken. 
So vermeiden Sie Klick- und Knackgeräusche:

 Stellen Sie sicher, dass der Beginn und das Ende 
einer Selektion sich so nahe wie möglich an einem 
Punkt befinden, an dem die Amplitude der 
Wellenform die Nulllinie der Wellenformanzeige 
schneidet (die Mittellinie der Wellenform-
darstellung). Verwenden Sie, wenn nötig, 
die Tools zum Zoomen im Edit-Fenster 
(siehe „Zoomoptionen“ auf Seite 548), 
um die Wellenform detaillierter anzuzeigen.

 Wenden Sie einen Crossfade zwischen Clips an, 
wenn ein Klick- oder Knackgeräusch auftritt. 
Weitere Hinweise finden Sie unter „Erzeugen 
eines Crossfades“ auf Seite 635.

 Verwenden Sie in Pro Tools HD die AutoFade-
Funktion, um Echtzeit-Fade-Ins/Outs für alle 
Clipgrenzen zu erzeugen, die nicht an andere Clips 
angrenzen oder mit ihnen überlappen. Weitere 
Hinweise finden Sie unter „Arbeiten mit 
AutoFades“ auf Seite 636.

Nichtdestruktives Editieren 
von Audio
Wenn Sie die Playlist einer Audiospur in 
Pro Tools bearbeiten, schneiden und kleben 
Sie das Audiomaterial nicht tatsächlich neu 
zusammen, wie es bei der Verwendung von 
analogen Bändern der Fall wäre. Stattdessen 
erzeugt Pro Tools eine Abbildung der 
Audiodatei auf Ihrer Festplatte, in der die 
Wiedergabereihenfolge der verschiedenen 
Audioabschnitte festgelegt wird.

Verwenden Sie mehrere Playlists, wenn Sie 
Audioclips mit einem Trim-Tool bearbeiten oder 
die Position bzw. Reihenfolge von Clips innerhalb 
einer Spur ändern. Auf diese Weise können Sie die 
vorgenommenen Änderungen auch leicht wieder 
rückgängig machen. Weitere Informationen finden 
Sie unter „Playlists“ auf Seite 645.

Audioclips und 
Automationsdaten
Automationsdaten für Audiomaterial befinden sich 
auf Spuren und nicht in der Clipliste. Wenn Sie also 
Audioclips von der Clipliste auf eine neue Spur 
ziehen, werden dadurch keine Automationsdaten 
auf diese Spur bewegt. Anders verhält es sich, wenn 
Sie einen Audioclip von einer bereits bestehenden 
Spur, die Automationsdaten enthält, auf eine 
andere Spur ziehen. In diesem Fall werden die 
Automationsdaten von der Ausgangsspur auf die 
Zielspur verschoben.

Sie können Automationsdaten bearbeiten, indem 
Sie Spurdarstellungsformate wechseln oder unter 
den Spuren Automations-Lanes anzeigen.

Selektion mit Beginn und Ende an der Nulllinie

Weitere Informationen zur Automation 
finden Sie unter Kapitel 45: „Automation“.
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MIDI-Clips und MIDI-Daten
MIDI- und Instrumentenspuren werden vor allem 
in der Noten- und Clip-Darstellung bearbeitet:

 Verwenden Sie Clip-Darstellung zur 
Anordnung von Clips.

 Verwenden Sie die Notendarstellung zum 
Einfügen und Bearbeiten von einzelnen MIDI-
Noten oder zum Arbeiten mit Notengruppen.

Clip-Darstellung für MIDI- und 
Instrumentenspuren
MIDI- und Instrumentenspuren können in der Clip-
Darstellung angezeigt werden. Diese Darstellung 
ähnelt der Waveform-Darstellung von 
Audiospuren. Obwohl die Noten einer Spur in 
der Clip-Darstellung sichtbar sind, können 
die einzelnen Noten in dieser Darstellung nicht 
bearbeitet werden. Das Editieren erfolgt stattdessen 
über einen Zeitbereich, der alle Spurdaten 
einschließlich der Continuous Controller-Events, 
Program Changes und Sysex-Events enthält.

Verwenden Sie die Clip-Darstellung zur Definition 
von Clips, die bestimmte Songausschnitte und Clips 
repräsentieren, oder zum Neuanordnen und 
Zusammenstellen von Spurmaterial.

In der Clip-Darstellung ist der vertikale Zoom 
automatisch so skaliert, dass er für den gesamten 
Bereich der Tonhöhen von MIDI-Noten in einer 
Spur passt.

Beim Selektieren, Kopieren, Ausschneiden 
und Trimmen von MIDI-Clips ist Folgendes 
zu beachten:

 Wird ein selektierter Clip oder eine Clipgruppe, 
die den Anfangspunkt einer Note enthalten, 
ausgeschnitten oder gelöscht, wird die gesamte 
Note entfernt. Dies gilt auch, wenn nur der Teil der 
Note, der den Anfangspunkt enthält, selektiert wird.

 Beim Kopieren oder Ausschneiden eines 
selektierten Clips oder einer Clipgruppe, die den 
Endpunkt (jedoch nicht den Anfangspunkt) einer 
Note enthält, bleibt die Note bestehen und reicht 
über die Grenze des Clips hinaus.

Weitere Informationen zu Spurdarstellungs-
formaten finden Sie unter „Spurdarstellungen“ 
auf Seite 225.

Um die Spurdarstellung zwischen „Notes“ 
und „Clips“ zu wechseln, klicken Sie auf 
die gewünschte Spur und drücken Sie bei 
gedrückter Windows-Taste (Windows) bzw. 
Ctrl-Taste (Mac) die Minustaste auf der 
alphanumerischen Tastatur.

Sie können in einen MIDI-Clip doppelklicken, 
um ihn im MIDI Editor-Fenster zu öffnen. 
Siehe Kapitel 32: „MIDI-Editoren“.

Ausschneiden eines MIDI-Clips mit Notenüberlappung
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 Ähnliches gilt, wenn MIDI-Clips oder -
Clipgruppen, die MIDI-Clips enthalten, mit einem 
der Trim-Tools getrimmt werden. Wenn der 
Startpunkt eines MIDI-Clips über den Startpunkt 
einer Note hinaus verschoben wird, wird die Note 
entfernt. Wenn der Endpunkt des Clips so 
getrimmt wird, dass sich der Startpunkt einer Note, 
jedoch nicht deren Endpunkt innerhalb des Clips 
befindet, bleibt die Note bestehen und reicht über 
die Grenze des Clips hinaus.

Beim Verschieben und Platzieren von MIDI-Clips 
mit überlappenden Noten werden die Noten immer 
mit den Clips verschoben. Werden solche MIDI-
Clips neben oder in der Nähe eines anderen Clips 
platziert, ragen diese Noten in den angrenzenden 
Clip auf der Spur hinein.

Auf Taktstrichen erstellte MIDI-Clips

Bei der MIDI-Aufnahme oder bei der manuellen 
Eingabe von MIDI-Noten werden der Anfang 
und das Ende der resultierenden MIDI-Clips 
auf Taktgrenzen begrenzt. Dies ermöglicht 
die einfache Anordnung von MIDI-Clips auf 
musikalisch sinnvolle Art in ganzen Taktlängen.

Der Anfang eines aufgenommenen MIDI-Clips 
beginnt immer mit dem Taktstrich direkt vor der 
ersten MIDI-Note (Note On) des Clips. Der MIDI-
Clip endet auch mit dem Taktstrich direkt nach der 
letzten Note (Note Off) des Clips. 

MIDI-Clips und Continuous 
Controller-Events

Continuous Controller-Events befinden sich nicht 
in Spuren, sondern in MIDI-Clips. Wenn Sie daher 
Clips, die Controller-Daten enthalten, von einer 
Spur oder aus der Clipliste auf eine andere Spur 
verschieben, werden sämtliche Controller-Daten 
auf die Zielspur geschrieben.

Sie können Continuous Controller-Events 
bearbeiten, indem Sie Spurdarstellungen wechseln 
oder unter den Spuren Controller-Lanes anzeigen.

MIDI-Stummschaltungsautomation

Im Unterschied zu Continuous Controller-Events, 
die Nuancen einer MIDI-Einspielung 
repräsentieren, ist „Mute“ in Pro Tools eine 
Automation Playlist, die das Stummschalten der 
MIDI-Engine bewirkt. Die Mute Automation hat 
nichts mit den eigentlichen MIDI-Events zu tun 
und wird deshalb bei der Speicherung einer 
Standard-MIDI-Datei nicht berücksichtigt.

Um beim Trennen, Ausschneiden oder 
Kopieren von Clips MIDI-Noten zu trennen 
und nicht überlappen zu lassen, nehmen Sie 
die gewünschte Edit-Selektion vor, wechseln 
Sie zur Notendarstellung und verwenden Sie 
den Separate At Selection-Befehl. Wechseln 
Sie dann zurück zur Clip-Darstellung und 
führen Sie die Editieraufgabe aus (Trennen, 
Schneiden oder Kopieren).

Weitere Informationen zum Bearbeiten von 
MIDI-Controller-Daten finden Sie unter 
Kapitel 31: „Editieren von MIDI-Daten“.
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Notendarstellung für MIDI- und 
Instrumentenspuren
Wenn für eine MIDI- oder Instrumentenspur die 
Notes-Darstellung eingestellt wurde, werden die 
MIDI-Noten im „Pianorollenformat“ angezeigt. 
Jede Note erscheint als ein kleines Rechteck. 
Die vertikale Position des Rechtecks zeigt hierbei 
die Tonhöhe an, die horizontale Position des 
Rechtecks signalisiert den zeitlichen Beginn und 
die Dauer der Note.

Am linken Rand der Playlist für die MIDI- oder 
Instrumentenspur befindet sich ein Mini-Keyboard 
mit Oktavbezeichnungen als Tonhöhenreferenz. 
Sie können auf das Mini-Keyboard klicken, um 
Tonhöhen mit dem ausgewählten MIDI-Ausgang 
wiederzugeben. Mithilfe der Bildlaufpfeile 
oberhalb und unterhalb des Mini-Keyboards 
können Sie in der Notendarstellung hinauf- und 
hinunterscrollen.

In der Notendarstellung hängt der Tonumfang, in 
dem MIDI-Noten angezeigt werden können, von 
der Darstellungshöhe der Spur und dem aktuellen 
Zoomwert ab. Liegen Noten der Spur außerhalb 
des aktuell dargestellten Bereichs, werden sie als 
einzelne Pixellinien am oberen und unteren Rand 
der Darstellung angezeigt.

So scrollen Sie in der Notendarstellung einer MIDI- 
oder Instrumentenspur nach oben bzw. nach unten:

 Klicken Sie auf einen der Bildlaufpfeile des 
Mini-Keyboards.

 Aktivieren Sie eines der Edit-Tools (etwa den 
Time Grabber), drücken Sie Strg + Alt + 
Windows (Windows) bzw. Befehl + Wahl + 
Ctrl (Mac) und ziehen Sie auf dem Mini-
Keyboard nach oben oder nach unten.

 Wenn Sie eine Maus mit Scroll-Rad haben, 
bewegen Sie den Cursor auf die Spur und 
scrollen Sie durch die Notendarstellung, 
während Sie Strg + Alt + Windows (Windows) 
bzw. Befehl + Wahl + Ctrl (Mac) 
gedrückt halten.

Mit den Edit-Tools können Noten eingefügt, 
gelöscht, transponiert, getrimmt und verschoben 
werden. Weitere Informationen finden Sie unter 
„Manuelles Editieren von MIDI-Noten“ auf 
Seite 700.

Notendarstellung einer MIDI-Spur

Durch Klicken auf das Mini-Keyboard wird 
die aktuelle Edit-Selektion gelöscht. Weitere 
Informationen finden Sie unter „Selektieren 
von MIDI-Noten“ auf Seite 700.

Pfeil nach oben

Pfeil nach unten

MIDI-Note außerhalb der aktuellen Anzeige

Keyboard-Referenz MIDI-Note

Scrollen der Notendarstellung mit dem Bildlaufpfeil 
(nach oben)

Scrollen der Notendarstellung durch Ziehen
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Nichtdestruktives Editieren 
von MIDI
Während das Bearbeiten von Audioclips 
normalerweise nicht destruktiv ist, trifft dies auf 
MIDI-Clips im Allgemeinen nicht zu. Existiert ein 
MIDI-Clip beispielsweise nur an einer bestimmten 
Stelle einer einzigen Spur, ist das Editieren dieses 
Clips destruktiv. Dies bedeutet, dass bei Änderung 
der Tonhöhe, Dauer oder Position von Noten in der 
Notendarstellung der Clip irreversibel 
verändert wird.

Ist jedoch die Option Mirror MIDI Editing 
deaktiviert, wenn ein MIDI-Clip bearbeitet wird, 
der an einer anderen Stelle in der Session auftritt 
(an einer anderen Position in der Spur, in einer 
anderen Playlist oder in einer anderen Spur), 
ist das Bearbeiten nicht destruktiv und ein neuer 
automatisch erstellter Clip wird erzeugt. Um Ihre 
Änderungen rückgängig zu machen, ziehen Sie 
den ursprünglichen Clip aus der Clipliste auf 
die Spur oder verwenden Sie eine vorher 
gespeicherte Playlist.

Benennen von Clips
Sie können Clips mit anschaulicheren Namen 
umbenennen oder vorhandene Namen 
vereinfachen. Wenn Sie einen beim Editieren 
automatisch erzeugten Clip umbenennen, wird 
dieser zu einem benutzerdefinierten Clip, der auch 
dann noch in der Clipliste angezeigt wird, wenn 
automatisch erzeugte Clips ausgeblendet werden.

So benennen Sie einen Clip in einer Spur um:

1 Sie haben folgende Möglichkeiten:

• Selektieren Sie den umzubenennenden Clip und 
wählen Sie dann Clip > Rename.

• Klicken Sie mit einem der Edit-Tools mit der 
rechten Maustaste in den Clip, den Sie 
umbenennen möchten, und wählen Sie aus dem 
Popup-Menü Rename.

• Drücken Sie Strg + Umschalt + R (Windows) 
bzw. Befehl + Umschalt + R (Mac).

• Doppelklicken Sie mit dem Grabber-Tool auf 
den Clip, den Sie umbenennen möchten. 
Für MIDI-Clips muss die Option Name Dialog 
als die Double-Clicking a MIDI Clip Opens-
Einstellung in den MIDI-Voreinstellungen 
ausgewählt sein.

2 Geben Sie im Name-Dialogfeld einen neuen 
Namen für den Clip ein. Wenn ein Clip 
ausgewählt ist, der eine gesamte Audiodatei 
umfasst, geben Sie an, ob nur der Clip oder der 
Clip und die Datei umbenannt werden sollen.

3 Klicken Sie auf OK, um den Clip umzubenennen. 

Eine Möglichkeit, sicher zum Zustand einer 
Spur vor dem Editieren zurückzukehren, 
besteht in der Verwendung von Playlists. 
Bevor Sie Noten bearbeiten oder Clips 
trimmen bzw. anders anordnen, sollten Sie 
eine Kopie der bestehenden Playlist der Spur 
anfertigen und statt des Originals diese 
Kopie verwenden (siehe „Playlists“ auf 
Seite 645).

Um das Editieren auf alle Instanzen eines 
MIDI-Clips anzuwenden, aktivieren Sie den 
Mirrored MIDI Editing-Modus (siehe 
„Mirrored MIDI Editing“ auf Seite 695).

Weitere Informationen finden Sie unter 
„Umbenennen von Clips“ auf Seite 277.
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Anzeigen von Clipnamen, 
Clipzeiten und anderen Daten
Namen und zeitliche Position von Clips 
können unter Umständen beim Editieren von 
Audiowellenformen und MIDI-Daten stören. 
In solchen Fällen besteht die Möglichkeit, 
sie auszublenden. In anderen Fällen, z. B. beim 
Anordnen oder Positionieren von Foley, ist die 
Anzeige von Clipnamen und -zeiten sehr hilfreich.

So aktivieren oder deaktivieren Sie die Anzeige 
von Clipnamen in Playlists:

 Aktivieren oder deaktivieren Sie View > 

Clip > Name.

So zeigen Sie Clipzeiten an:

 Wählen Sie unter View > Clip eine der 
folgenden Optionen:

Keine Zeit. – deaktiviert die Anzeige 
der Clipzeiten.

Aktuelle Zeit. – zeigt die Start- und Endzeiten von 
Clips an.

Originalzeitstempel. – zeigt den 
Originalzeitstempel der einzelnen Clips an. 
Der Originalzeitstempel ist die ursprüngliche 
Timecode-Position eines Clips bei der ersten 
Aufnahme oder Erstellung.

Benutzerzeitstempel. – zeigt den Anwender-
Zeitstempel der einzelnen Clips an. Der User Time 
Stamp entspricht zunächst dem Original Time 
Stamp, kann jedoch über den Befehl Time Stamp 
neu definiert werden.

Anzeige von Clipdaten auf allen Kanälen

Für Stereo- und Mehrkanalspuren können 
Clipdaten auf allen Kanälen angezeigt werden.

So aktivieren oder deaktivieren Sie die Anzeige 
von Clipdaten in allen Kanälen:

 Wählen Sie View > Clip > Display on 

All Channels.

Anzeigen anderer Clipinformationen

Sie können auch die folgenden Informationen 
in Clips anzeigen:

Sync-Punkte. – kann in Clips in Playlists 
angezeigt werden. Dies ist beim visuellen Spotting 
auf Timecode oder Anordnen im Grid-Modus 
hilfreich. Weitere Informationen finden Sie unter 
„Sync-Punkte“ auf Seite 862.

Bearbeitungsstatus. – für Clips, die mit Elastic 
Audio verarbeitet werden, wird eine Warp-
Anzeige in Playlists und in der Clipliste angezeigt. 
Siehe „Gewarpte Clips“ auf Seite 923.

Kanalname und Informationen zu Szenen und 
Takes. – können in Clips in Playlists und in der 
Clipliste angezeigt werden. Dies ist beim Arbeiten 
mit Mehrkanal-Aufnahmen und Metadaten, 
die mit einem Field Recorder aufgenommen 
wurden, hilfreich. Detaillierte Informationen 
zu Workflows für Field Recorder finden Sie in 
Kapitel 51: „Arbeit mit tragbaren Rekordern und 
Pro Tools“.

Bewertung. – kann in Clips in Playlists angezeigt 
werden. Dies ist für die Anordnung bei der Arbeit 
mit mehreren Playlists und alternativen Takes 
hilfreich. Siehe „Bewerten von Clips“ auf Seite 623.

Clip-Overlaps. – kann in Clips in Playlists 
angezeigt werden. Dies ist beim Anordnen und 
beim Arbeiten mit tickbasierten Audiospuren 
nützlich. Siehe „Überlappen und Verdecken 
von Clips“ auf Seite 603.

Für Clipnamen, Überlappungen und Clipzeiten 
aktivierte Anzeige
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Clip-Gain-Linie. – zeigt die Clip-Gain-Linie für 
alle Clips im Edit-Fenster an. In der Clip-Gain-
Linie bearbeiten Sie die Clip-Gain-Einstellungen 
eines Clips mit Hilfe von Breakpoints, ähnlich wie 
bei der spurbasierten Lautstärkeautomation. Siehe 
„Clip-Gain-Linie“ auf Seite 613.

Clip Gain Info. – zeigt am Anfang des Clips in der 
linken unteren Ecke das Clip Gain Fader-Symbol 
an. Beim Verwenden von statischem Clip-Gain 
wird der statische Wert (–144 dB bis +36 dB) 
rechts vom Clip-Gain-Fader-Symbol angezeigt. 
Bei Clips mit dynamischem Clip-Gain 
(Verwendung von Breakpoints) wird der Clip-
Gain-Wert nicht angezeigt. Weitere Informationen 
finden Sie unter „Clip-Gain-Informations-
Anzeige“ auf Seite 612.

Rückgängigmachen mehrerer 
Vorgänge
Pro Tools kann bis zu 32 Vorgänge 
zurückverfolgen und rückgängig machen. 
Dies gibt Ihnen die Möglichkeit, zu einem 
früheren Zustand zurückzukehren. 

Die Vorgänge, die in Pro Tools rückgängig 
gemacht werden können, werden in der 
Reihenfolge gespeichert, in der sie ausgeführt 
wurden. Wählen Sie Edit > Undo, um den letzten 
Vorgang rückgängig zu machen. Wenn Sie die 
Option Undo erneut wählen, wird der Schritt davor 
rückgängig gemacht. Mit Edit > Redo können 
Sie einen rückgängig gemachten Vorgang 
wiederherstellen und sich so schrittweise wieder 
nach vorn bewegen.

Erreicht die Anzahl der Arbeitsschritte in der 
Undo-Reihe den festgelegten Höchstwert der 
Vorgänge, die rückgängig gemacht werden 
können (Informationen finden Sie auf der 
Editing Preferences-Registerkarte), wird durch 
den folgenden Undo-Vorgang der Arbeitsschritt 
am oberen Ende der Reihe entfernt.

Um den letzten Vorgang rückgängig zu machen, 
führen Sie einen der folgenden Schritte aus:

 Wählen Sie Edit > Undo.

 Drücken Sie Strg + Z (Windows) bzw. Befehl + 
Z (Mac).

Um den zuletzt rückgängig gemachten Vorgang 
wiederherzustellen, führen Sie einen der 
folgenden Schritte aus:

 Wählen Sie Edit > Redo.

 Drücken Sie Umschalt + Strg + Z (Windows) 
bzw. Umschalt + Befehl + Z (Mac).

Wenn keine Aktionen rückgängig gemacht 
werden können, wird „Can't Undo“ angezeigt.

Wenn keine Aktionen wiederhergestellt werden 
können, wird „Can't Redo“ angezeigt.
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Undo History-Fenster
Im Undo History-Fenster können Sie die 
Liste der letzten Vorgänge anzeigen und durch 
Rückgängigmachen bzw. Wiederherstellen zu 
einem früheren Zustand zurückkehren. Es können 
auch Erstellungs- und Änderungsuhrzeiten 
angegeben werden, wodurch es möglich ist, 
zum Status einer Session zu einem bestimmten 
Zeitpunkt zurückzukehren. 

So blenden Sie das Undo History-Fenster ein 
bzw. aus:

 Wählen Sie Window > Undo History.

So machen Sie Vorgänge im Undo History-
Fenster rückgängig:

 Klicken Sie in der Liste auf den Vorgang (fett), 
den Sie rückgängig machen möchten. 

Alle Vorgänge in der Liste, die nach dem 
ausgewählten Vorgang ausgeführt wurden, 
werden dadurch ebenfalls rückgängig gemacht. 
Im Undo History-Fenster werden Vorgänge, 
die rückgängig gemacht werden können, 
fett und wiederherstellbare Vorgänge (Vorgänge, 
die bereits rückgängig gemacht wurden) 
kursiv angezeigt.

So stellen Sie Vorgänge im Undo History-
Fenster wieder her:

 Klicken Sie in der Liste auf den Vorgang 
(kursiv), den Sie wiederherstellen möchten.

Der von Ihnen ausgewählte Vorgang sowie alle 
Vorgänge davor in der Liste werden 
wiederhergestellt.

So ändern Sie die Anzeige der Erstellungszeit im 
Undo History-Fenster:

 Klicken Sie auf das Options-Popup-Menü und 
wählen Sie Show Creation Times. 

So machen Sie alle Vorgänge in der Undo-Reihe 
rückgängig:

 Klicken Sie auf das Options-Popup-Menü und 
wählen Sie Undo All.

So stellen Sie alle Vorgänge in der Undo-Reihe 
wieder her:

 Klicken Sie auf das Options-Popup-Menü und 
wählen Sie Redo All.

Undo History (Fenster)

Undo-
Vorgänge

Redo- 
Vorgänge

Erstellungszeit

Optionsauswahl
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Löschen der Undo-Reihe

So löschen Sie manuell die Undo-Reihe:

 Klicken Sie auf das Options-Popup-Menü und 
wählen Sie Clear Undo Queue.

Auch durch andere Vorgänge wird die Undo-
Reihe gelöscht. Dazu gehören die folgenden:

• Löschen einer Spur oder eines Clips aus 
der Clipliste

• Auswählen von Select > Unused oder Select > 

Unused Audio Except Whole Files im Popup-
Menü der Clipliste

Erreicht die Anzahl der Arbeitsschritte in der 
Undo History den Höchstwert der Vorgänge, 
die rückgängig gemacht werden können, wird 
durch den folgenden Undo-Vorgang der 
Arbeitsschritt am oberen Ende der Reihe entfernt. 
Kurz bevor der älteste Vorgang aus der Reihe 
entfernt wird, wird er rot angezeigt.

Zahl der Undo-Vorgänge 
und Speicher
Da in Pro Tools die Playlists für alle bearbeiteten 
Spuren zurückverfolgt werden, kann eine lange 
Undo-Reihe speicheraufwendig sein. Sie können 
die Einstellung Levels of Undo (Editing-
Voreinstellungen) in Pro Tools herabsetzen, 
um Arbeitsspeicher (RAM) zu sparen. Wenn für 
Pro Tools viel Speicher vorhanden ist, können 
Sie für Levels Of Undo eine höhere Einstellung 
verwenden.

So stellen Sie in Pro Tools die Zahl der Undo-
Schritte ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Editing-Registerkarte.

2 Klicken Sie in das Levels of Undo-Feld und 
wählen Sie einen Wert zwischen 1 und 64.

3 Klicken Sie auf OK.

Einfache Bearbeitungsbefehle
Pro Tools bietet viele standardmäßige 
Bearbeitungsbefehle (wie Cut, Copy und Paste). 
Darüber hinaus bietet Pro Tools auch spezielle 
Bearbeitungsbefehle, die für die Audio- und 
MIDI-Produktion optimiert wurde (wie Repeat 

Paste to Fill).

Cut, Copy, Paste und Clear
Verwenden Sie die Befehle Cut (Ausschneiden), 
Copy (Kopieren), Paste (Einfügen) und Clear 
(Löschen), um Material neu anzuordnen und zu 
bearbeiten. Editiervorgänge können entweder an 
kompletten Clips durchgeführt werden, nachdem 
diese mit dem Time Grabber-Tool selektiert 
wurden, oder an bestimmten Abschnitten einer 
Spur, die mit dem Selektor-Tool ausgewählt 
wurden. Dabei können Editiervorgänge auch über 
mehrere Spuren hinweg erfolgen (siehe „Editieren 
über mehrere Spuren hinweg“ auf Seite 542).

Im Undo History-Fenster können Sie die Liste 
der letzten Vorgänge anzeigen und zu einem 
früheren Zustand zurückkehren.

Levels of Undo (Voreinstellung)

Sie können nicht benachbarte Clips 
ausschneiden, kopieren und einfügen, 
indem Sie sie mit dem Object Grabber-
Tool auswählen.
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Darstellung und Editieren 
von Spuren
Wenn Sie Material auf einer Spur ausschneiden 
oder kopieren, wird durch die Spurdarstellung 
festgelegt, welche Art von Daten in der 
Zwischenablage gespeichert werden. Beim 
Bearbeiten der Master-Darstellung einer Spur 
(Waveform-Darstellung für Audiospuren 
und Clip-Darstellung für MIDI- oder 
Instrumentenspuren) kann eine Selektion alle 
darin enthaltenen Automations- und Controller-
Daten umfassen („Automation Follows Edit-
Option“ auf Seite 1081). Dies bedeutet, dass beim 
Ausschneiden eines Audio-Clips auch sämtliche 
in der Spur befindlichen Volume-, Pan-, 
Stummschaltungs-, Send-, Continuous Controller- 
oder Plug-In-Automationsdaten ausgeschnitten 
werden. Sie müssen diese Daten also nicht extra 
aus jeder einzelnen Automation Playlist der Spur 
ausschneiden.

Wenn Sie mit einem der Grabber-Tools eine 
Gruppe von MIDI-Noten in der Notendarstellung 
auswählen (indem Sie ein Rechteck um sie herum 
ziehen), werden nur die Notendaten in der 
Zwischenablage gespeichert. Wenn Sie einen 
bestimmten Zeitabschnitt von MIDI-Noten 
(in der Notendarstellung) mit dem Selector-Tool 
auswählen, werden sämtliche Controller-Daten 
der Spur auch ausgewählt (ähnlich wie beim 
Auswählen mit dem Selector-Tool bei 
Audiospuren in der Waveform-Darstellung).

Wenn eine Spur Automations- oder Controller-
Daten anzeigt, werden nur diese Daten in der 
Zwischenablage gespeichert. Außerdem werden 
jedes Mal, wenn Sie Automationsdaten 
ausschneiden oder kopieren, an jedem Ende des 
selektierten Abschnitts Breakpoints erzeugt, 
um den Verlauf der Automation innerhalb und 
außerhalb des selektierten Bereichs zu erhalten.

Gehört die Spur zu einer Gruppe, so wirkt sich das 
Kopieren und Einfügen auch auf alle anderen 
Spuren der Gruppe aus. Ausgeblendete Spuren 
werden durch Editiervorgänge nicht geändert, 
selbst wenn sie Teil einer Gruppe sind, die 
bearbeitet wird.

Die Option „Shuffle Clips“ wirkt sich darauf aus, 
wie Material ausgeschnitten und eingefügt wird:

• Im Shuffle Clips-Modus entsteht bei 
Verwendung des Cut-Befehls keine Lücke, 
da die Clips rechts von der Schnittstelle nach 
links gleiten und die Lücke so geschlossen wird. 
Im Slip-Modus entsteht bei Verwendung des 
Cut-Befehls eine Lücke an der Position, an der 
die Daten von der Spur entfernt wurden. 

Audiomaterial in der Waveform-Darstellung

Automationsdaten mit ausgeschnittenem und 
eingefügtem Audioclip

Verwenden Sie Strg + Windows + V 
(Windows) bzw. Befehl + Ctrl + V (Mac), 
um Automationsdaten in einen anderen 
Automationstyp mit der Special Paste-
Funktion einzufügen. Beispielweise können 
Sie eine Pan-Automation in eine Volume-
Automations-Playlist kopieren.
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• Wenn „Shuffle Clips“ aktiviert ist, können 
eingefügte Daten dazu führen, dass alle 
Clips verschoben werden, damit Platz für 
das eingefügte Material entsteht. Ansonsten 
können eingefügte Daten einen benachbarten 
Clip überlappen.

Durch Editiervorgänge werden häufig neue Clips 
automatisch erzeugt. Wenn etwa eine Selektion 
mit dem Clear-Befehl aus einem Clip entfernt 
wird, werden aus dem Material rechts und links der 
Selektion automatisch neue Clips erzeugt.

Cut- und Copy-Befehle
Verwenden Sie den Cut-Befehl, um die Selektion 
aus der Spur zu entfernen und in die 
Zwischenablage aufzunehmen.

Mit dem Copy-Befehl speichern Sie eine Kopie der 
Selektion in der Zwischenablage, damit sie auf 
einer anderen Spur oder an einer anderen Position 
auf derselben Spur eingefügt werden kann, wobei 
das Original intakt und am selben Platz bleibt.

So verwenden Sie den Cut- bzw. Copy-Befehl, 
um eine Selektion oder einen Clip zu bearbeiten:

1 Aktivieren Sie „Snap to Grid“, um die Selektion 
durch das aktuell eingestellte Raster zu begrenzen. 

2 Stellen Sie die gewünschte Spurdarstellung für 
die Spuren ein, die Sie bearbeiten möchten.

Wenn bei Audiospuren die Waveform-Darstellung 
oder bei MIDI-Spuren die Darstellung von Noten 
oder Clips ausgewählt ist, schließt die jeweilige 
Selektion auch die zugrunde liegenden 
Automations- und Controller-Daten ein. Wenn die 
Spur Automationsdaten anzeigt, sind nur diese 
Daten von den Editiervorgängen betroffen.

3 Nehmen Sie eine Edit-Selektion des 
auszuschneidenden (Cut) bzw. zu kopierenden 
(Copy) Audiomaterials vor.

4 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Cut, um die Selektion 
zu entfernen und in die Zwischenablage 
zu kopieren.

• Wählen Sie Edit > Copy, um die Selektion in der 
Zwischenablage zu speichern, ohne sie von der 
Spur zu entfernen.

Wenn ein Teil eines Clips ausgeschnitten oder 
kopiert wurde, erscheint das Material aus der 
Zwischenablage als neuer Clip in der Clipliste. 
Wenn ein Teil eines Clips ausgeschnitten wurde, 
werden aus dem Material rechts und links der 
Selektion automatisch neue Clips erzeugt. 

Wenn „Shuffle Clips“ aktiviert ist, werden alle 
folgenden Clips verschoben, um die leere 
Fläche zu füllen.

Löschen von zugrunde liegenden Clipdaten

Beim Entfernen eines Clips oder einer Selektion 
können Sie wählen, ob Sie die zugrunde liegenden 
Clipdaten entfernen oder behalten möchten.

So löschen Sie einen Clip oder eine Selektion 
zusammen mit den zugrunde liegenden Clipdaten:

 Wählen Sie Edit > Cut.

So löschen Sie einen Clip oder eine Selektion, 
ohne die zugrunde liegenden Clipdaten zu 
entfernen:

 Wählen Sie Edit > Clear.

Weitere Informationen zur Option „Shuffle 
Clips“ finden Sie unter „Shuffle-Modus“ auf 
Seite 543.

Weitere Informationen zur Edit-Selektion 
finden Sie unter „Selektieren von 
Spurmaterial“ auf Seite 577.
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Paste-Befehl
Mit dem Paste-Befehl fügen Sie den Inhalt der 
Zwischenablage am Edit-Einfügepunkt ein, wobei 
das an dieser Position bereits vorhandene Material 
überschrieben wird.

So fügen Sie eine Selektion oder einen Clip ein:

1 Aktivieren Sie „Snap to Grid“, um den 
Einfügepunkt oder die Selektion durch das 
aktuell eingestellte Raster zu begrenzen. 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Selector-Tool auf die Stelle 
in einer Spur, an der Sie das Material 
einfügen möchten.

• Verwenden Sie das Selector- oder Time 
Grabber-Tool, um einen Bereich zu selektieren, 
in den das Material eingefügt werden soll.

3 Wählen Sie Edit > Paste.

Wenn Sie Daten an einem Einfügepunkt einfügen 
und „Shuffle Clips“ aktiviert ist, wird das Material 
rechts vom Einfügepunkt nach rechts verschoben. 
Andernfalls wird das Material im Einfügebereich 
überschrieben.

Wenn Sie Daten in eine Selektion einfügen und 
„Shuffle Clips“ aktiviert ist, wird die Selektion 
durch den Inhalt der Zwischenablage ersetzt und 
angrenzendes Material falls nötig nach rechts oder 
links verschoben. Andernfalls wird die Selektion 
ebenfalls ersetzt, das angrenzende Material bleibt 
jedoch unverändert.

Clear-Befehl
Verwenden Sie den Clear-Befehl, um eine 
Selektion von einer Spur zu entfernen, ohne dass 
diese in der Zwischenablage gespeichert wird.

So löschen Sie eine Selektion oder einen Clip mit 
dem Clear-Befehl:

1 Aktivieren Sie „Snap to Grid“, um die Selektion 
durch das aktuell eingestellte Raster zu begrenzen. 

2 Stellen Sie die gewünschte Spurdarstellung für 
die Spuren ein, die Sie bearbeiten möchten.

Wenn bei Audiospuren die Waveform-Darstellung 
oder bei MIDI-Spuren die Darstellung von 
Noten oder Clips ausgewählt ist, schließt die 
jeweilige Selektion auch die zugrunde liegenden 
Automations- und Controller-Daten ein. Wenn die 
Spur Automationsdaten anzeigt, sind nur diese 
Daten von den Editiervorgängen betroffen.

3 Treffen Sie eine Edit-Selektion.

4 Wählen Sie Edit > Clear, um die Selektion 
zu entfernen.

Wenn ein Teil eines Clips gelöscht wurde, werden 
aus dem Material rechts und links der Selektion 
automatisch neue Clips erzeugt. Wenn „Shuffle 
Clips“ aktiviert ist, werden alle folgenden Clips 
verschoben, um die leere Fläche zu füllen.

Klicken Sie bei gedrückter Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) mit dem 
Grabber-Tool in einen Clip, um ihn der 
aktuellen Selektion anzupassen.

Wenn Sie mit MIDI-Spuren arbeiten, können 
Sie den Inhalt der Zwischenablage mit dem 
Material in der Zielspur zusammenführen. 
Verwenden Sie dazu „Edit > Paste Special > 
Merge“. Weitere Informationen finden Sie 
unter „Paste Special“ auf Seite 1109.
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Spezielle Befehle zum 
Ausschneiden, Kopieren, 
Einfügen und Löschen
Verwenden Sie die vier „Spezial-Befehle“ des Edit-
Menüs (Cut Special, Copy Special, Paste Special 
und Clear Special) zum Editieren von Automation-
Playlists (Volume-, Pan-, Mute- und Plug-In-
Automation) auf Audio-, Auxiliary-Eingangs-, 
Master-Fader- und Instrumentenspuren. Diese 
Befehle können auch für MIDI-Controller-Daten in 
MIDI- und Instrumentenspuren genutzt werden. 
Es gibt auch die Befehle Cut Special, Copy Special 
und Clear Special zum Ausschneiden, Kopieren 
und Löschen der Clip-Gain-Einstellungen (siehe 
„Clip-Gain“ auf Seite 611).

Repeat To Fill Selection-Befehl
Mit dem Repeat to Fill Selection-Befehl können Sie 
automatisch Audio- oder MIDI-Clips oder -Daten 
in einen selektierten Abschnitt einfügen, ohne die 
entsprechenden Clips hierfür einzeln manuell 
vervielfältigen zu müssen. Um den Repeat to Fill 

Selection-Befehl zu verwenden, müssen Sie einen 
Audio- oder MIDI-Clip kopieren (Copy) oder 
ausschneiden (Cut), einen Bereich zum Einfügen 
selektieren und den Befehl ausführen, um die 
Selektion einzufügen. Beim Einfügen von 
Audioclips werden Sie aufgefordert, einen 
Crossfade anzugeben, der für die eingefügten Clips 
verwendet werden soll. 

Wenn Sie Material in einen Bereich einfügen, 
dessen Länge ein ganzzahliges Vielfaches der 
Länge des kopierten Clips ist (also beispielsweise 
wenn Sie einen 4-taktigen Clip in einen Bereich 
von 16 Takten Länge einfügen möchten), dann 
wird die kopierte Selektion so oft hintereinander 
eingefügt, wie es zum Ausfüllen der Selektion 
erforderlich ist. Wenn Sie Material in einen 
Bereich einfügen, dessen Länge nicht exakt durch 
die Länge des kopierten Clips geteilt werden kann 
(beispielsweise wenn in einen Bereich von 
15 Sekunden Länge ein Clip von zwei Sekunden 
Länge eingefügt wird), wird der übrig bleibende 
Selektionsbereich mit einer automatisch 
getrimmten Version der ursprünglichen 
Selektion ausgefüllt.

So füllen Sie eine Selektion mit dem Repeat to 
Fill Selection-Befehl aus:

1 Selektieren Sie den Clip, den Sie 
kopieren möchten.

2 Wählen Sie Edit > Copy.

3 Selektieren Sie den auszufüllenden Bereich mit 
dem Selector-Tool und wählen Sie Edit > Paste 

Special > Repeat to Fill Selection.

4 Sie haben folgende Möglichkeiten:

• Beim Einfügen von Audioclips in größere 
Bereiche wird das Batch Fades-Dialogfeld 
geöffnet. Geben Sie hier die Werte zum 
Einfügen von Crossfades zwischen den 
einzelnen eingefügten Clips ein und klicken 
Sie auf OK.

• Wenn für die eingefügten Audioclips keine 
Crossfades erzeugt werden sollen, klicken Sie 
im Batch Fades-Dialogfeld auf Cancel.

Es ist nicht möglich, MIDI-Controller-
Daten in Automationsdaten einzufügen 
oder umgekehrt.

Weitere Informationen finden Sie unter 
„Ausschneiden, Kopieren und Einfügen von 
Automationsdaten“ auf Seite 1106.
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Editieren über mehrere 
Spuren hinweg
Wenn Sie mit Daten aus mehreren verschiedenen 
Spuren arbeiten möchten, sollten Sie einige 
wichtige Dinge beachten. Wenn beispielsweise 
das Darstellungsformat von ausgewählten 
Spuren auf das Master-Darstellungsformat 
(siehe „Master-Darstellungsformate für Spuren“ 
auf Seite 230) eingestellt ist, betreffen 
Bearbeitungsvorgänge nicht nur die Audio- 
und MIDI-Daten der ausgewählten Spuren, 
sondern auch sämtliche Automations- und 
Controller-Daten.

Wenn das Darstellungsformat aller selektierten 
Spuren auf Automationsdaten eingestellt ist, 
wirken sich Editiervorgänge nur auf den Typ von 
Automationsdaten aus, der in der jeweiligen Spur 
angezeigt wird. Wenn also auf Spur 1 Pan-Daten, 
auf Spur 2 Volume-Daten und auf Spur 3 Mute-
Daten angezeigt werden, dann werden mit dem 
Cut-Befehl auf Spur 1 nur die Pan-Daten, auf Spur 
2 die Volume-Daten und auf Spur 3 die Mute-
Daten ausgeschnitten.

So kopieren Sie alle Arten von Automation in allen 
ausgewählten Spuren, wenn nur Automation- oder 
Controller-Daten kopiert werden:

 Wählen Sie Edit > Copy Special > All 

Automation.

So fügen Sie mehrere Spuren ein:

1 Sie haben folgende Möglichkeiten:

• Platzieren Sie den Einfügepunkt in den 
einzelnen Zielspuren, indem Sie bei gedrückter 
Umschalttaste in die Spuren klicken.

• Nehmen Sie in einer der Zeitbasis-Leisten eine 
Selektion vor.

2 Wählen Sie Edit > Paste.

Wenn Sie Daten unterschiedlichen Typs 
gleichzeitig einfügen, werden alle Daten in die 
richtigen Playlists eingefügt. Automationsdaten 
werden in die entsprechende Automation Playlist 
eingefügt. Audio- oder MIDI-Daten werden in die 
Audio- oder MIDI-Playlist eingefügt. Das 
Definieren einer Zielspur für den betreffenden 
Datentyp ist daher für einen korrekten 
Einfügevorgang nicht nötig.

Wenn beim Einfügen in mehrere Spuren alle 
Zielspuren Automationsdaten anzeigen, ersetzt das 
eingefügte Material die vorher in der Zielspur 
vorhandenen Daten, ohne dass diese verschoben 
werden. Dabei spielt es keine Rolle, ob „Shuffle 
Clips“ aktiviert ist.

Weitere Informationen zum Auswählen von 
Daten in mehreren Spuren finden Sie unter 
„Selektieren über mehrere Spuren hinweg“ 
auf Seite 584.
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Kapitel 25: Edit-Modi und Edit-Tools

Pro Tools bietet vier Edit-Modi und verschiedene 
Edit-Tools, die Sie beim Editieren Ihres Materials 
unterstützen.

Edit-Modi
Pro Tools verfügt über vier Edit-Modi: Shuffle, 
Spot, Slip und Grid. Außerdem kann der Grid-
Modus als absoluter oder relativer Modus 
verwendet werden. Sie können den gewünschten 
Edit-Modus auswählen, indem Sie auf die 
entsprechende Schaltfläche oben links im Edit-
Fenster klicken.

Der Edit-Modus beeinflusst das Verschieben und 
die Positionierung von Audio- und MIDI-Clips 
(und MIDI-Noten), das Verhalten der Copy- und 
Paste-Befehle und die Funktionsweise der Edit-
Tools „Trim“, „Selector“, „Grabber“ und „Pencil“.

Shuffle-Modus
Im Shuffle-Modus können Sie Clips innerhalb 
einer Spur oder in andere Spuren verschieben, 
Sie können Spuren kürzen (trimmen), löschen, 
ausschneiden oder einfügen. Die Positionierung 
kann jedoch von anderen Clips beeinflusst werden. 
Wenn Sie etwa mehrere Clips auf einer Spur 
platzieren, rücken diese automatisch aneinander. 
Sie können die Reihenfolge der Clips 
danach ändern. Es ist jedoch nicht möglich, 
sie voneinander zu trennen oder sie wie im Slip-
Modus überlappen zu lassen. Wenn es jedoch stille 
Passagen zwischen vorhandenen Clips gibt und 
die Clips verschoben werden, bleiben die stillen 
Passagen erhalten und werden nicht entfernt.

Wenn im Shuffle-Modus ein Clip am Anfang einer 
Spur eingefügt wird, werden alle vorhandenen 
Clips um die Länge dieses Clips nach rechts 
(späterer Zeitpunkt) verschoben. 

Wenn Sie im Shuffle-Modus eines der Trim-Tools 
verwenden, werden bei der Änderung des Start- 
oder Endpunkts eines Clips die folgenden Clips 
automatisch entlang der Zeitachse verschoben. 
Im Shuffle-Modus gibt es für das Einfügen 
und Anordnen von MIDI-Noten keine 
Einschränkungen.

Edit-Modus-Schaltflächen

Verwenden Sie die Akzenttaste ( ` ), 
um zwischen den Edit-Modi zu wechseln.

Drücken Sie F1, um den Shuffle-Modus 
zu aktivieren. 
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Sperren des Shuffle-Modus
Bei bestimmten Workflows muss der Shuffle-
Modus ausgeschlossen werden, um sicherzustellen, 
dass die zeitliche Abstimmung der Clips beim 
Editieren erhalten bleibt. Mit „Shuffle Lock“ wird 
verhindert, dass Sie versehentlich den Shuffle-
Modus aufrufen, indem alle wichtigen Befehle und 
Schalter der Bedienoberfläche für den Shuffle-
Modus deaktiviert werden. Im Shuffle-Modus 
können Sie „Shuffle Lock“ nicht aufrufen. 

So sperren Sie den Shuffle-Modus:

 Wenn Sie sich in einem anderen Edit-Modus 
als dem Shuffle-Modus befinden, klicken Sie 
bei gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf die Shuffle-Schaltfläche 
auf dem Bildschirm. Ein Schlosssymbol wird 
auf der Shuffle-Schaltfläche angezeigt. 

So heben Sie die Sperre des Shuffle-Modus 
wieder auf:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf 
die gesperrte Shuffle-Schaltfläche auf 
dem Bildschirm.

Slip-Modus
Im Slip-Modus können Sie Clips innerhalb einer 
Spur oder auf andere Spuren verschieben. Dieser 
Modus ermöglicht es, einen Clip so zu platzieren, 
dass zwischen ihm und angrenzenden Clips auf der 
Spur Lücken entstehen. Wenn die Spur 
wiedergegeben wird, bleiben diese Lücken stumm. 
Ein Clip kann so verschoben werden, dass er einen 
anderen Clip teilweise oder vollständig überlagert.

Verwenden Sie den Slip-Modus, wenn Sie mit 
dem Trim-, Selector-, Grabber- oder Pencil-Tool 
ohne Einschränkungen hinsichtlich der zeitlichen 
Anordnung von Clips arbeiten möchten.

Spot-Modus
Verwenden Sie den Spot-Modus, um Clips an 
genau festgelegten Stellen zu positionieren. 
Im Spot-Modus können Sie eine Frame-Position 
(oder eine Position, die auf einem beliebigen 
anderen Zeitformat basiert) angeben. Es ist ferner 
möglich, eine eingehende Timecode-Adresse zu 
erfassen oder den Zeitstempel eines Clips als 
Referenz für das Spotting zu verwenden. Das ist 
besonders für die Positionierung von SMPTE-
Frames während der Postproduktion sinnvoll. 

Ist der Spot-Modus aktiviert, fordert Pro Tools Sie 
auf, ein Ziel anzugeben, wenn ein Clip aus der 
Clipliste, einem Workspace-Browser, Windows-
Explorer oder Mac Finder gezogen wird.

„Shuffle Lock“ aktiviert
Drücken Sie F2, um den Slip-Modus 
zu aktivieren. 

Drücken Sie F3, um den Spot-Modus 
zu aktivieren. 
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Grid-Modus
Im Grid-Modus „rasten“ Clips und MIDI-Noten 
beim Verschieben, Trimmen oder Einfügen 
entsprechend dem derzeit selektierten Rasterwert 
oder dem anwenderdefinierten Zeitraster ein. 

Anzeigen von Rasterlinien

Um die Rasterlinien im Edit-Fenster oder in 
einem MIDI Editor-Fenster einzublenden 
(oder auszublenden), führen Sie einen der 
folgenden Schritte aus:

 Aktivieren (bzw. deaktivieren) Sie die Grid-
Schaltfläche.

 Klicken Sie auf den Namen der gerade 
ausgewählten Zeitbasis-Leiste.

Absolutes und relatives Raster
Der Grid-Modus kann als absoluter oder relativer 
Modus verwendet werden. 

 Im Absolute Grid-Modus rastet der Startpunkt 
des Clips beim Ziehen automatisch an den 
nächstgelegenen Rastergrenzen ein. Wenn der 
Startpunkt eines Clips zwischen Schlägen liegt und 
das Raster auf Viertelnoten gesetzt ist, rastet der 
Startpunkt des Clips bei der nächstgelegenen 
Viertelnote (aktueller absoluter Grid-Wert) ein. 

 Im Relative Grid-Modus werden Clips nach 
Raster- (oder Nudge-Einheiten) verschoben. Wenn 
der Startpunkt eines Clips zwischen Schlägen liegt 
und das Raster auf eine Viertelnote gesetzt ist 
(vorausgesetzt, die Viertelnote stellt einen 
Taktschlag dar), werden Clips in Viertelnoten-
Schritten verschoben, wodurch die relative 
Position des Clips zum nächsten Beat erhalten 
bleibt. Weitere Informationen zum Relative Grid-
Modus finden Sie unter „Verschieben von Clips im 
Grid-Modus“ auf Seite 858. 

So wählen Sie den absoluten oder relativen 
Grid-Modus:

 Klicken Sie auf den Selektor für den Grid-
Modus und wählen Sie Absolute oder Relative. 

Drücken Sie F4, um den Grid-Modus 
zu aktivieren. 

Grid-Schaltfläche im Edit-Fenster aktiviert

Einblenden der Rasterlinien über eine 
Zeitbasis-Leiste

Um beim Ziehen eines Clips den Grid-
Modus zeitweilig zu deaktivieren und in den 
Slip-Modus zu wechseln, halten Sie nach 
dem Klicken die Strg-Taste (Windows) bzw. 
die Befehlstaste (Mac) gedrückt.
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Ausrichtung am Raster
In Pro Tools können Sie in den Modi Shuffle, 
Slip oder Spot die Snap To Grid-Option 
aktivieren. Wenn Sie dies getan haben, sind 
Platzierungen des Edit-Cursors und die Edit-
Selektion durch das Raster beschränkt; jedoch 
hat der andere ausgewählte Edit-Modus auch 
Auswirkungen auf das Bearbeiten von Clips. 

Wenn beispielsweise im Shuffle-Modus die Snap 
To Grid-Option aktiviert ist, können Sie in einem 
Clip auf Grundlage des Rasters eine Selektion 
vornehmen und die Selektion ausschneiden; 
dann werden alle Clips rechts neben dem Edit 
nach links verschoben.

So aktivieren Sie die Snap To Grid-Option in einem 
anderen Edit-Modus:

 Klicken Sie bei gedrückter Umschalttaste 
auf die Schaltfläche für den Grid-Modus.

So aktivieren Sie Shuffle, Slip oder Spot im 
Grid-Modus:

 Klicken Sie bei gedrückter Umschalttaste auf 
die Schaltfläche für den Shuffle-, Slip- oder 
Spot-Modus.

Konfigurieren des Rasters
Die eigentliche Rastergröße wird mithilfe des 
Selektors für die Einstellung des Rasterwerts 
festgelegt. Sie kann auf einem Zeitformat der 
Zeitskala beruhen. Ist die Option Follow Main 
Time Scale deaktiviert, kann auch jedes andere 
Zeitformat zur Einstellung der Rastergröße 
verwendet werden. 

Die Grid Value-Anzeige und der zugehörige 
Selektor befinden sich im Edit-Fenster. Zusätzlich 
weisen auch das Score Editor- und die MIDI 
Editor-Fenster eine unabhängige Grid Value-
Anzeige und einen -Selektor auf.

Shuffle-Modus mit aktivierter Snap To Grid-Option

Halten Sie die Umschalttaste gedrückt und 
drücken Sie F4, um die Snap To Grid-Option 
in einem anderen Edit-Modus zu aktivieren.

Drücken Sie F1 + F4, um die Snap To Grid-
Option und den Shuffle-Modus zu aktivieren. 
Drücken Sie F2 + F4, um die Snap To Grid-
Option und den Slip-Modus zu aktivieren. 
Drücken Sie F3 + F4, um die Snap To Grid-
Option und den Spot-Modus zu aktivieren.

Grid Value (Anzeige und Popup-Menü)

Der aktuelle Grid-Wert wird auch für 
den Quantize to Grid-Befehl (siehe 
„Quantisieren von Clips am Raster“ auf 
Seite 609) und den Separated Clip At Grid-
Befehl verwendet (siehe „Separate-Befehle“ 
auf Seite 600).
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Wenn im Grid Value-Menü die Clips/Markers-
Option ausgewählt ist, können Events wie im Slip-
Modus frei positioniert werden. Sie rasten jedoch 
an bestimmten Clip-Punkten (Start-, End- und 
Sync-Punkten), Markern und Edit-Selektionen ein, 
wenn sie in deren Nähe positioniert werden.

Sperren des Grid-Modus
Falls Sie verhindern möchten, dass Sie 
versehentlich die Einstellung des Grid-Modus 
ändern, wenn Sie Tastenkombinationen für den 
Edit-Modus verwenden, können Sie die Option 
Edit/Tool Mode Keyboard Lock aktivieren.

So sperren (oder entsperren) Sie den 
ausgewählten Grid-Modus:

1 Klicken Sie auf den Selektor für den Grid-
Modus und wählen Sie Absolute oder Relative.

2 Aktivieren (oder deaktivieren) Sie Options > 

Edit/Tool Mode Keyboard Lock.

Edit-Tools
Pro Tools bietet die folgenden Edit-Tools: 
Zoomer, Trim, Selector, Grabber, Scrubber und 
Pencil sowie das multifunktionale Smart-Tool. 

So wählen Sie ein Edit-Tool aus:

 Klicken Sie in der Symbolleiste auf das Symbol 
für das gewünschte Tool. 

Die Zoom-, Trim-, Grabber- und Pencil-Tools 
verfügen über mehrere Modi, die Sie aus einem 
Popup-Menü auswählen können, wenn Sie auf das 
Tool klicken.

Zoomschaltflächen. – verwenden Sie die 
Zoomschaltflächen, um in MIDI- und 
Audiospurmaterial vertikal und horizontal 
heran- oder herauszuzoomen. Sie können auch 
fünf Zoomvoreinstellungen speichern und 
wieder aufrufen.

Wenn Sie MIDI-Noten mit dem Pencil-Tool 
einfügen, wird die Option „Clips/Markers“ 
ignoriert. Die Noten rasten stattdessen 
entsprechend dem im Grid Value-Selektor 
ausgewählten Zeitwert ein.

Zoomschaltflächen und Edit-Tools

Sie können mit F5 (Zoomer), F6 (Trim), 
F7 (Selector), F8 (Grabber), F9 (Scrubber) 
und F10 (Pencil) das Edit-Tool auswählen 
und zwischen den jeweils dazugehörigen 
Modi wechseln. 

Durch wiederholtes Drücken der Esc-Taste 
können Sie durch die Edit-Tools blättern.

Zoomschaltflächen Zoomer Smart-Tool Scrubber
Stift

Zoom Toggle

Trim

Selector
Grabber
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Zoomer-Tool. – verwenden Sie das Zoomer-Tool, 
um eine Zoomdarstellung in einer Spur 
auszuwählen.

Zoom Toggle. – verwenden Sie „Zoom Toggle“, 
um zwischen der aktuellen Zoomdarstellung und 
einer definierten Zoomdarstellung zu wechseln.

Trim-Tools. – verwenden Sie die Trim-Tools, 
um Clips und Clip-Gruppen zu trimmen.

Selector Tool. – verwenden Sie das Selector-Tool, 
um Selektionen auf Spuren auszuführen.

Grabber-Tools. – verwenden Sie die Grabber-
Tools, um Clips auf Spuren zu selektieren, 
zu trennen oder zu verschieben.

Smart-Tool. – verwenden Sie das Smart-Tool, 
um Clips auf Spuren zu trimmen, zu selektieren 
und zu fassen.

Scrubber Tool. – verwenden Sie das Scrubber-
Tool, um durch Spurmaterial zu scrubben.

Pencil Tool. – verwenden Sie das Pencil-Tool, 
um Automations- und MIDI-Daten zu zeichnen.

Zoomoptionen
In Pro Tools gibt es folgende Zoomoptionen: 
Zoomschaltflächen, das Zoomer-Tool, 
die Schaltflächen für die Zoomvoreinstellungen 
und den Befehl „Zoom Toggle“.

Zoomschaltflächen
Pro Tools enthält verschiedene Zoomschaltflächen 
für das Heran- und Herauszoomen von Spurdaten.

Das Edit-Fenster, die MIDI Editor-Fenster und das 
Score Editor-Fenster weisen Zoomschaltflächen 
auch oberhalb und unterhalb der rechten vertikalen 
Bildlaufleiste auf (siehe „Zoom-Schaltflächen 
im Edit-Fenster“ auf Seite 178, „MIDI Editor-
Zoom-Steuerelemente“ auf Seite 742 und „Score 
Editor-Zoom-Steuerelemente“ auf Seite 765).

Schaltflächen für das 
horizontale Vergrößern und 
Verkleinern
Mit den Schaltflächen „Horizontal Zoom In“ und 
„Horizontal Zoom Out“ können Sie Spurdaten 
horizontal vergrößern und verkleinern.

Führen Sie einen der folgenden Schritte aus, 
um auf allen Spuren horizontal zu vergrößern:

 Klicken Sie auf die Schaltfläche „Horizontal 
Zoom In“.

 Ziehen Sie die Schaltfläche „Horizontal Zoom 
In“, um kontinuierlich zu vergrößern.

 Drücken Sie Strg + ] (Windows) bzw. Befehl + ] 
(Mac).

Weitere Informationen zur Nutzung der Edit-
Tools in der Notendarstellung von MIDI- und 
Instrumentenspuren finden Sie unter 
Kapitel 31: „Editieren von MIDI-Daten“.

Weitere Informationen zur Nutzung der Edit-
Tools in der Warp-Darstellung und der 
Analysis-Darstellung für Elastic Audio-
fähige Spuren finden Sie unter „Editieren in 
der Warp-Darstellung“ auf Seite 917 und 
„Bearbeitung in der Analysis-Darstellung“ 
auf Seite 924.

Schaltflächen „Horizontal Zoom In“ und „Horizontal 
Zoom Out“ 
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Führen Sie einen der folgenden Schritte aus, 
um auf allen Spuren horizontal zu verkleinern:

 Klicken Sie auf die Schaltfläche „Horizontal 
Zoom Out“.

 Ziehen Sie die Schaltfläche „Horizontal Zoom 
Out“, um kontinuierlich zu verkleinern.

 Drücken Sie Strg + [ (Windows) bzw. 
Befehl + [ (Mac).

Audio- und MIDI-
Zoomschaltflächen
Mit der Audio- bzw. der MIDI-Zoomschaltfläche 
können Sie Audio- bzw. MIDI-Daten vertikal 
vergrößern und verkleinern.

Führen Sie einen der folgenden Schritte aus, 
um alle Audiospuren vertikal zu vergrößern:

 Klicken Sie auf die Schaltfläche „Audio 
Zoom In“. 

 Ziehen Sie die Schaltfläche „Audio Zoom In“, 
um kontinuierlich zu zoomen.

 Drücken Sie Strg + Alt + ] (Windows) bzw. 
Befehl + Wahl + ] (Mac).

Führen Sie einen der folgenden Schritte aus, 
um all Audiospuren vertikal zu verkleinern:

 Klicken Sie auf die Schaltfläche „Audio 
Zoom Out“. 

 Klicken Sie auf die Schaltflächen für vertikales 
Audio-Zoomen.

 Drücken Sie Strg + Alt + [ oder Strg + Alt + ] 
(Windows) bzw. Befehl + Wahl + [ oder 
Befehl + Wahl + ] (Mac). 

So zoomen Sie alle Audiodaten vertikal, um die 
Standardhöhe der Wellenform anzuzeigen:

 Drücken Sie die Tastenkombinationen Strg + 
Alt + Windows + [ (Windows) oder Befehl + 
Wahl + Ctrl + [ (Mac).

Führen Sie einen der folgenden Schritte aus, um 
alle MIDI- und Instrumentenspuren vertikal zu 
vergrößern:

 Klicken Sie auf die Schaltfläche „MIDI 
Zoom In“.

 Drücken Sie Strg + Umschalt + ] (Windows) 
bzw. Befehl + Umschalt + ] (Mac).

Führen Sie einen der folgenden Schritte aus, 
um allen MIDI- und Instrumentenspuren vertikal 
zu verkleinern:

 Klicken Sie auf die Schaltfläche „MIDI 
Zoom Out“.

 Drücken Sie Strg + Umschalt + [ (Windows) 
bzw. Befehl + Umschalt + [ (Mac).

Schaltfläche für vertikales Audio-Zoomen

Schaltfläche für vertikales MIDI-Zoomen

Der vertikale MIDI-Zoom wirkt sich nur auf 
Spuren aus, die sich nicht in der Clips-
Darstellung befinden.
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So zoomen Sie MIDI-Material vertikal, um alle 
Noten (tiefste bis höchste) in MIDI- und 
Instrumentenspuren anzuzeigen:

 Drücken Sie Strg + Windows + 
Umschalt + [ (Windows) bzw. Befehl + 
Ctrl + Umschalt + [ (Mac).

So zoomen Sie auf einer einzelnen MIDI- oder 
Instrumentenspur vertikal heran oder heraus:

1 Vergewissern Sie sich, dass „Track View“ nicht 
auf Clips festgelegt ist.

2 Aktivieren Sie das Zoomer-Tool. 

3 Drücken Sie die Windows-Taste (Windows) 
oder die Ctrl-Taste (Mac), und ziehen Sie nach 
oben, um heranzuzoomen, oder nach unten, 
um herauszuzoomen.

Weitere Tastenbefehle für 
das Zoomen

Um zur vorherigen Zoomstufe zurückzukehren, 
führen Sie einen der folgenden Schritte aus:

 Klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) auf eine 
der horizontalen, Audio- oder MIDI-
Zoomschaltflächen.

 Drücken Sie Strg + Alt + E (Windows) bzw. 
Befehl + Wahl + E (Mac).

So vergrößern Sie horizontal die Edit-Selektion, 
ohne den vertikalen Zoom zu beeinflussen:

 Drücken Sie Alt + F (Windows) bzw. 
Wahl + F (Mac).

Enthält die Selektion MIDI-Noten, werden die 
ausgewählten MIDI-Noten vertikal gescrollt, 
um sie ggf. in Spuren anzuzeigen.

Führen Sie einen der folgenden Schritte aus, 
um eine Selektion horizontal heranzuzoomen, 
ohne die vertikale Zoom- oder Scrollfunktion 
zu beeinträchtigen:

 Drücken Sie Alt + Windows + F (Windows) 
bzw. Wahl + Ctrl + F (Mac).

 Drücken Sie Strg + Windows + ] (Windows) 
bzw. Befehl + Ctrl + ] (Mac).

Führen Sie einen der folgenden Schritte aus, 
um horizontal zu zoomen, sodass die gesamte 
Session angezeigt wird:

 Doppelklicken Sie in der Symbolleiste auf 
das Zoomer-Tool.

 Drücken Sie Alt + A (Windows) bzw. 
Wahl + A (Mac).

Audiowellenformen nehmen wieder den 
standardmäßigen vertikalen Zoom an. Bei Spuren 
in der Notendarstellung werden MIDI-Noten 
vertikal gezoomt, um alle Noten in der Spur 
anzuzeigen (wie beim vertikalen Zoom in der 
Clips-Darstellung). Der Tempo Editor zoomt 
vertikal, um alle Tempo-Events anzuzeigen.

Führen Sie einen der folgenden Schritte aus, 
um durch horizontales Zoomen die ganze Session 
anzuzeigen, ohne die vertikale Zoom- oder 
Scrollfunktion zu beeinträchtigen:

 Drücken Sie Alt + Windows + A (Windows) 
bzw. Wahl + Ctrl + A (Mac).

 Drücken Sie Strg + Windows + [ (Windows) 
bzw. Befehl + Ctrl + [ (Mac).

So legen Sie den horizontalen Zoom auf den 
Übersichtsmaßstab (256 Samples pro Pixel) fest:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehls-Taste (Mac) auf das 
Zoomer-Tool.
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Zoomer-Tool
Mit dem Zoomer-Tool können Sie einen 
bestimmten Bereich in einer Spur vergrößern 
und verkleinern. 

Das Zoomer-Tool kann in zwei Modi 
verwendet werden: 

Normal Zoom-Modus. – das Zoomer-Tool bleibt 
nach dem Zoomen ausgewählt. 

Single Zoom-Modus. – nach dem Zoomen ist das 
zuvor verwendete Edit-Tool wieder aktiv.

Normal Zoomer-Tool

So zoomen Sie den Bereich um eine bestimmte 
Position in einer Spur:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie im Popup-Menü des Zoomer-Tools 
den normalen Zoom-Modus.

• Klicken Sie mit der rechten Maustaste auf eine 
Spur und wählen Sie Tools > Zoomer Tools > 

Normal Zoom.

2 Klicken Sie einmal mit dem Zoomer-Tool auf 
die Position innerhalb der Spur. Alle Spuren 
werden um eine Stufe vergrößert und die 
vergrößerte Position wird in der Mitte des Edit-
Fensters angezeigt.

3 Klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) erneut 
mit dem Zoomer-Tool, um zur vorherigen 
Zoomstufe zurückzukehren.

So vergrößern Sie einen bestimmten Bereich 
der Spur:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie im Popup-Menü des Zoomer-
Tools den normalen Zoom-Modus.

• Klicken Sie mit der rechten Maustaste auf eine 
Spur und wählen Sie Tools > Zoomer Tools > 

Normal Zoom.

2 Sie haben folgende Möglichkeiten:

• Zum einfachen horizontalen Zoomen ziehen 
Sie das Zoomer-Tool um einen Bereich in der 
Playlist der Spur.

• Zum horizontalen und vertikalen Zoomen 
ziehen Sie bei gedrückter Strg-Taste (Windows) 
oder Ctrl-Taste (Mac) den Zoomer um einen 
Bereich in der Playlist.

Der vergrößerte Bereich füllt das Edit-Fenster aus.

Drücken Sie die Taste F5, um das Zoomer-
Tool auszuwählen und zwischen dem 
normalen und einfachen Zoom-Modus zu 
wechseln.

Zoomer-Tool

Horizontales Zoomen mit dem Zoomer-Tool
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Single Zoom-Modus 
Im einfachen Zoom-Modus ist automatisch 
nach dem Zoomen das zuvor ausgewählte Tool 
wieder aktiv.

Wenn Sie etwa das Smart-Tool verwenden, 
klicken Sie auf das einfache Zoomer-Tool 
und kehren nach dem Zoomen mit Pro Tools 
automatisch zum Smart-Tool zurück.

Führen Sie einen der folgenden Schritte aus, 
um den einfachen Zoom-Modus zu verwenden:

 Wählen Sie im Popup-Menü des Zoomer-Tools 
den einfachen Zoom-Modus.

 Klicken Sie mit der rechten Maustaste auf eine 
Spur und wählen Sie Tools > Zoomer Tools > 

Single Zoom.

 Drücken Sie die F5-Taste, um in den einfachen 
Zoom-Modus zu wechseln.

Der einfache Zoom-Modus ist am Pfeil rechts 
neben dem Zoomer-Symbol zu erkennen. 

Im Normal Zoom-Modus befindet sich neben dem 
Zoomer-Tool-Symbol kein Pfeil.

Zoomen in einer Leiste

So zoomen Sie horizontal in einer Leiste:

1 Drücken Sie die Strg- und Windows-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) und bewegen Sie den Mauszeiger in 
den Leistenbereich, sodass das Zoomer-
Tool erscheint.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie einmal, um den Bereich um eine 
bestimmte Position um eine Stufe zu vergrößern.

• Ziehen Sie den Cursor um einen Leistenbereich, 
um einen bestimmten Bereich zu vergrößern.

Kontinuierlicher Zoom mit dem 
Zoomer-Tool
Verwenden Sie das Zoomer-Tool zum 
kontinuierlichen Heran- oder Herauszoomen. 

So verwenden Sie kontinuierlichen Zoom auf einer 
Spur oder einer Gruppe von Spuren:

1 Aktivieren Sie das Zoomer-Tool. 

2 Wenden Sie bei gedrückter Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) eine der 
folgenden Vorgehensweisen an:

• Ziehen Sie nach oben, um kontinuierlich 
vertikal heranzuzoomen. 

• Ziehen Sie nach unten, um kontinuierlich 
vertikal herauszuzoomen. 

• Ziehen Sie nach rechts, um kontinuierlich 
horizontal heranzuzoomen.

• Ziehen Sie nach links, um kontinuierlich 
horizontal herauszuzoomen.

Bei horizontalem Zoom zoomen alle Spuren 
zusammen. Spuren werden horizontal zentriert 
an der Position heran- oder herausgezoomt, 
an der Sie klicken. 

Single Zoom-Modus

Zoomen in einer Leiste
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Kontinuierliches vertikales 
Heran- oder Herauszoomen 
auf allen Audiospuren

So zoomen Sie vertikal auf allen Audiospuren mit 
dem kontinuierlichen Zoom heran oder heraus:

 Ziehen Sie die Schaltfläche „Audio Zoom In“ 
oder „Audio Zoom Out“ nach oben oder 
nach unten. 

So zoomen Sie alle MIDI- und Instrumentenspuren, 
für die die Notendarstellung festgelegt ist, mit dem 
kontinuierlichen Zoom heran oder heraus:

 Ziehen Sie die Schaltfläche „MIDI Zoom In“ 
oder „MIDI Zoom Out“ nach oben oder nach 
unten. Offsets der Wellenformhöhen 
bleiben erhalten.

Führen Sie einen der folgenden Schritte aus, 
um horizontal zu zoomen und die gesamte 
Session anzuzeigen, um die Audiowellenform 
zurückzusetzen, sodass die Standardhöhe 
angezeigt wird, um MIDI zu zoomen, sodass alle 
Noten in einer Spur angezeigt werden, und um den 
Tempo Editor zu zoomen, sodass alle Tempo-
Events angezeigt werden:

 Doppelklicken Sie auf das Zoomer-Tool. 

 Drücken Sie Alt + A (Windows) bzw. 
Wahl + A (Mac).

So zoomen Sie nur horizontal, sodass die gesamte 
Session angezeigt wird, ohne das vertikale 
Zoomen oder Scrollen zu beeinflussen:

 Drücken Sie Alt + Windows + A (Windows) 
bzw. Wahl + Ctrl + A (Mac).

So legen Sie die Wellenformhöhen aller 
Audiospuren so fest, dass sie mit der 
Wellenformhöhe der obersten Spur im Edit-
Fenster übereinstimmen:

 Halten Sie die Strg- und Umschalttaste 
(Windows) bzw. die Befehls- und 
Umschalttaste (Mac) gedrückt und klicken Sie 
auf die Audio Zoom-Schaltfläche. Alle Offsets 
der Wellenformhöhen gehen verloren.

So legen Sie die Notenhöhen aller MIDI- und 
Instrumentenspuren so fest, dass sie mit der 
Notenhöhe der obersten MIDI- oder 
Instrumentenspur im Edit-Fenster 
übereinstimmen:

 Halten Sie die Strg- und Umschalttaste 
(Windows) bzw. die Befehls- und 
Umschalttaste (Mac) gedrückt und klicken Sie 
auf die MIDI Zoom-Schaltfläche. Alle Offsets 
der Notenhöhen gehen verloren.

Dies hat auch Auswirkungen auf die Höhe 
der MIDI-Noten.

Um die Standardhöhen der Audio-
Wellenform zurückzusetzen, ohne die 
horizontale Zoomstufe oder die Höhe der 
MIDI-Noten zu beeinflussen, drücken Sie 
Strg + Alt + Start + [ (Windows) oder 
Befehl + Wahl + ctrl + [ (Mac)
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Zoomvoreinstellungen
In Pro Tools können Sie bis zu fünf horizontale 
Zoomvoreinstellungen im Edit-Fenster speichern, 
die durch Eingabe einer Zahl oder Klicken einer 
Zoomvoreinstellungs-Schaltfläche abgerufen 
werden können. 

So speichern Sie eine Darstellung als 
Zoomvoreinstellung:

1 Verwenden Sie das Zoomer-Tool, um die 
Spurdarstellung zu konfigurieren. 

2 Klicken Sie auf eine Zoomvoreinstellungs-
Schaltfläche (1–5), halten Sie die Taste 
gedrückt und wählen Sie aus dem Zoom Preset-
Popup-Menü die Save Zoom Preset-Option. 
Die Voreinstellungs-Schaltfläche leuchtet kurz 
auf, und jede vorher gespeicherte 
Zoomvoreinstellung für diese Nummer wird 
ersetzt. 

Führen Sie einen der folgenden Schritte aus, 
um eine gespeicherte Zoomvoreinstellung 
abzurufen:

 Klicken Sie auf die entsprechende 
Zoomvoreinstellungs-Schaltfläche (1–5). 

 Klicken Sie auf die Zoomvoreinstellungs-
Schaltfläche, halten Sie die Taste gedrückt und 
wählen Sie aus dem Zoom Preset-Popup-Menü 
die Recall Zoom Preset-Option.

Zoom Toggle
Mit „Zoom Toggle“ können Sie den Zoomstatus 
im Edit-Fenster definieren und zwischen 
Zoomstatus wechseln.

Zoom Toggle-Parameter
Mit Zoom Toggle werden die folgenden Parameter 
gespeichert und abgerufen:

• Vertical Zoom

• Horizontal Zoom

• Track Height

• Track View

• Grid Settings

Zoom Toggle-Voreinstellungen 
Mit den Zoom Toggle-Voreinstellungen wird 
festgelegt, wie „Zoom Toggle“ funktioniert. 
Passen Sie die Zoom Toggle-Voreinstellungen 
Ihrem Arbeitsablauf an. 

So ändern Sie die Zoom Toggle-Voreinstellungen:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Editing-Registerkarte.

3 Ändern Sie die Einstellungen und Optionen für 
„Zoom Toggle“.

Zoom Preset-Popup-Menü

Zoom Toggle-Voreinstellungen
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4 Klicken Sie auf OK.

Vertical Zoom

Selection. – wenn diese Option ausgewählt ist, 
wird beim Zoomwechsel die aktuelle Edit-
Selektion vertikal gezoomt.

Last Used. – wenn diese Option ausgewählt ist, 
wird beim Zoomwechsel nur der zuletzt 
gespeicherte Zoom Toggle-Status für MIDI-Noten 
in der Notendarstellung vertikal gezoomt. 

Horizontal Zoom

Selection. – wenn diese Option ausgewählt ist, 
wird beim Zoomwechsel die aktuelle Selektion 
horizontal gezoomt. Dies ist besonders bei der 
Audiobearbeitung nützlich.

Last Used. – wenn diese Option ausgewählt ist, 
wird beim Zoomwechsel der zuletzt gespeicherte 
Zoom Toggle-Status horizontal gezoomt. Mit 
dieser Option kann ein separates Editor-Fenster 
nachgestellt werden. Dies ist besonders bei der 
Bearbeitung von MIDI-Noten nützlich.

Remove Range Selection After Zooming In. 
– wenn diese Option ausgewählt ist, wird die 
aktuelle Edit-Selektion nach dem Zoomwechsel in 
einen Einfügepunkt reduziert.

Track Height

Last Used. – wenn diese Option ausgewählt ist, 
erhalten alle Spuren mit einer Edit-Selektion beim 
Zoomwechsel die zuletzt verwendete Spurhöhe.

Medium. – wenn diese Option ausgewählt ist, 
erhalten alle Spuren mit einer Edit-Selektion beim 
Zoomwechsel die mittlere Spurhöhe.

Large. – wenn diese Option ausgewählt ist, 
erhalten alle Spuren mit einer Edit-Selektion beim 
Zoomwechsel die große Spurhöhe.

Jumbo. – wenn diese Option ausgewählt ist, 
erhalten alle Spuren mit einer Edit-Selektion beim 
Zoomwechsel die sehr große Spurhöhe.

Extreme. – wenn diese Option ausgewählt ist, 
erhalten alle Spuren mit einer Edit-Selektion beim 
Zoomwechsel die größte Spurhöhe.

Fit To Window. – wenn diese Option ausgewählt 
ist, wird für alle Spuren mit einer Edit-Selektion 
beim Zoomwechsel die Spurhöhe an das Fenster 
angepasst.

Track View

Waveform/Notes. – wenn diese Option ausgewählt 
ist, wird beim Zoomwechsel die Spurdarstellung 
von Audiospuren zur Waveform-Darstellung und 
die Spurdarstellung von Instrumenten- und MIDI-
Spuren zur Notendarstellung geändert.

Warp/Notes. – wenn diese Option ausgewählt ist, 
wird beim Zoomwechsel die Spurdarstellung von 
Audiospuren zur Warp-Darstellung und die 
Spurdarstellung von Instrumenten- und MIDI-
Spuren zur Notendarstellung geändert.

Last Used. – wenn diese Option ausgewählt ist, 
wird beim Zoomwechsel die Spurdarstellung zur 
zuletzt verwendeten Spurdarstellung geändert, 
die mit dem Zoomwechsel gespeichert wurde.

Legen Sie für die MIDI-Bearbeitung die 
Zoom Toggle-Voreinstellungen wie folgt fest: 
„Vertical Zoom“ auf „Last Used“, 
„Horizontal Zoom“ auf „Last Used“, „Track 
View“ auf „Waveform/Notes“ und „Track 
Height“ auf „Fit to Window“.

Legen Sie für die Audiobearbeitung die 
Zoom Toggle-Voreinstellungen wie folgt 
fest: „Vertical Zoom“ auf „Selection“, 
„Horizontal Zoom“ auf „Selection“, 
„Track Height“ auf „Fit to Window“ und 
„Track View“ auf „No Change“.
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No Change. – wenn diese Option ausgewählt ist, 
wird die Spurdarstellung bei Zoomwechsel nicht 
geändert.

Separate Grid Settings When Zoomed In

Ist diese Option aktiviert, werden die mit dem 
Zoomwechsel gespeicherten Rastereinstellungen 
beim Zoomwechsel erneut aufgerufen. Wenn diese 
Option nicht ausgewählt ist, bleiben bei 
Zoomwechseln die (aktuellen) 
Rastereinstellungen unverändert. 

Zoom Toggle Follows Edit Selection

Wenn diese Option ausgewählt ist, wird 
sichergestellt, dass der Zoomwechsel automatisch 
der aktuellen Edit-Selektion folgt. Wenn diese 
Option deaktiviert ist, hat das Ändern der Edit-
Selektion keine Auswirkungen auf die gerade 
angezeigte Spur.

Verwenden von Zoom Toggle 
Abhängig von den Einstellungen für die Zoom 
Toggle-Voreinstellungen können Sie mit der 
Zoom Toggle-Schaltfläche im Edit-Fenster einen 
Zoomstatus definieren und zwischen diesem 
Status und dem aktuellen Zoomstatus wechseln. 
Auch das Zoomen mit den Einstellungen in den 
Zoom Toggle-Voreinstellungen ist möglich. Wenn 
Zoom Toggle aktiviert ist, wird im Edit-Fenster 
der gespeicherte Zoomstatus angezeigt. Zusätzlich 
werden alle Änderungen im Zoomstatus 
gespeichert, die während aktiviertem Zoom 
Toggle an der Darstellung vorgenommen werden.

Wenn die Zoom Toggle-Schaltfläche deaktiviert 
ist, wird im Edit-Fenster der vorherige Zoomstatus 
angezeigt.

So speichern Sie einen Zoomstatus:

1 Legen Sie die Zoom Toggle-Voreinstellungen fest.

2 Treffen Sie eine Edit-Selektion.

3 Klicken Sie auf die Zoom Toggle-Schaltfläche. 
Durch das Leuchten wird angezeigt, dass Zoom 
Toggle aktiviert ist und Pro Tools den Zoom 
basierend auf den Einstellungen der Zoom 
Toggle-Voreinstellungen wechselt.

Wenn „Last Used“ für eine der folgenden 
Einstellungen ausgewählt ist, können Sie den 
entsprechenden Zoom, die Höhe oder die 
Darstellung im Edit-Fenster anpassen, um den 
gespeicherten Zoomstatus zu aktualisieren:

• Vertical Zoom

• Horizontal Zoom

• Track Height

• Track View

Zoom Toggle-Schaltfläche im Edit-Fenster

Drücken Sie bei aktivem Befehls-
Tastaturfokus (siehe „Tastaturfokus“ auf 
Seite 27) die E-Taste, um Zoom Toggle zu 
aktivieren oder zu deaktivieren.

Drücken Sie Alt + Umschalt + E (Windows) 
bzw. Wahl + Umschalt + E (Mac), um die 
Zoom Toggle-Funktion abzubrechen, ohne 
zur vorherigen Darstellung zurückzukehren.
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So ändern Sie den Zoom Toggle-Status, wenn 
„Last Used“ ausgewählt ist:

1 Stellen Sie sicher, dass die Zoom Toggle-
Schaltfläche erhellt (aktiviert) ist. 

2 Passen Sie „Track Height“, „Vertical Zoom“, 
„Track View“ oder das Raster in Abhängigkeit 
davon an, welche Voreinstellungen auf „Last 
Used“ festgelegt sind. Änderungen werden als 
neuer Zoom Toggle-Status gespeichert.

So löschen Sie den gespeicherten Zoom 
Toggle-Status:

1 Stellen Sie sicher, dass die Zoom Toggle-
Schaltfläche erhellt (aktiviert) ist. 

2 Klicken Sie bei gedrückter Alt- (Windows) 
bzw. Wahltaste (Mac) auf die Zoom Toggle-
Schaltfläche.

So verwenden Sie die Zoom Toggle-Funktion, 
ohne die Playlists-Darstellung zu ändern:

1 Wählen Sie einen Bereich oder eine Position 
auf einer oder mehreren Spuren.

2 Sie haben folgende Möglichkeiten:

• Drücken Sie Alt + Windows + E (Windows) 
bzw. Wahl + Ctrl + E (Mac).

• Drücken Sie bei aktivem Befehls-Tastaturfokus 
(siehe „Tastaturfokus“ auf Seite 27) Alt + E 
(Windows) bzw. Wahl + E (Mac).

Automatisches Wechseln beim 
Ändern der Selektion
Wenn Zoom Toggle aktiviert ist, wird es durch die 
Selektion eines anderen Bereichs des Materials 
oder von Material in einer anderen Spur wie 
folgt beeinflusst: 

• Durch Ändern der Länge der Selektion wird das 
Fenster nicht neu gezoomt, die aktuelle 
Zoomstufe bleibt bestehen. 

• Durch Ändern der Selektion auf eine andere 
Spur wird der herangezoomte Status für 
Spurhöhe und -darstellung festgelegt. 
Der horizontale Zoom bleibt jedoch 
unverändert. Wenn die Selektion von einer 
herangezoomten Spur verschoben wird, 
werden die vorherige Höhe und Darstellung 
wiederhergestellt.

Verwenden der Zoom Toggle-Funktion

Der automatische Wechsel 
funktioniert nicht für eine Edit-
Selektion über mehrere Spuren, 
bei denen für Zoom Toggle „Fit to 
Window“ festgelegt ist.
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Zoomen mit einem Mausrad
Wenn Sie eine Radmaus verwenden, können Sie 
das Rad zum vertikalen und horizontalen Heran- 
und Herauszoomen von Spuren einsetzen.

So zoomen Sie kontinuierlich horizontal mit 
einem Mausrad:

 Halten Sie die Alt-Taste (Windows) bzw. 
die Wahltaste (Mac) gedrückt, während Sie 
das Mausrad drehen.

So zoomen Sie das Audiomaterial (vertikales 
Zoomen) kontinuierlich im Edit-Fenster:

 Halten Sie Alt + Umschalt (Windows) bzw. 
Wahl + Umschalt (Mac) gedrückt, während Sie 
das Mausrad drehen.

So zoomen Sie das MIDI-Material (vertikales 
Zoomen) kontinuierlich im Edit-Fenster:

 Halten Sie Alt + Windows (Windows) bzw. 
Wahl + Ctrl (Mac) gedrückt, während Sie das 
Mausrad drehen.

So scrollen Sie horizontal durch die Inhalte des 
Edit-Fensters oder des Mix-Fensters:

1 Setzen Sie das Fenster, durch das Sie scrollen 
möchten, in den Fokus, indem Sie darauf 
klicken oder es in den Vordergrund legen.

2 Halten Sie die Umschalttaste gedrückt, 
während Sie das Mausrad drehen. 

Verwenden des Trim-Tools
Trim-Tools bieten Funktionen zum Trimmen von 
Clips, Noten und Daten. Die folgenden Trim-
Tools sind vorhanden:

• Trim-Tool, auch Standard-Trim-Tool genannt

• Time Compression/Expansion-Trim-Tool; auch 
TCE-Trim-Tool genannt

• Scrub Trim-Tool (Nur Pro Tools HD)

• Loop-Trim-Tool

Standard- und Scrub-Trim-Tool werden nur 
durch die Grenzen der vollständigen Audiodatei 
beschränkt, auf die sich der Clip bezieht. Beim 
Verwenden des TCE-Trim-Tools wird das 
Tool nur durch den maximalen TCE-Umfang 
(Time Compression/Expansion, 
Stauchen/Strecken) begrenzt.
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Trim Tool
Mit dem Trim-Tool können Sie einen Clip 
mühelos kürzen oder verlängern (bis zur gesamten 
Länge der aufgenommenen Audiodatei). Wenn Sie 
einen Clip zum ersten Mal trimmen, fügt Pro Tools 
ihn automatisch der Clipliste als neuen Clip hinzu 
(mit einem vom ursprünglichen Clip abgeleiteten 
Namen), sodass er vom ursprünglichen Clip 
unterschieden werden kann.

Das Trim-Tool ist ein nichtdestruktives Tool, 
durch das die Original-Audio- oder MIDI-Daten 
(bei der Bearbeitung von Clips) nicht verändert 
werden. Um dem bearbeiteten Clip seine 
ursprüngliche Länge zurückzugeben, können 
Sie ihn entweder durch das Original aus der 
Clipliste ersetzen oder mit dem Trim-Tool 
entsprechend verlängern.

Das Trim-Tool wird durch den jeweils aktivierten 
Edit-Modus beeinflusst: Shuffle, Slip, Spot oder 
Grid (siehe „Edit-Modi“ auf Seite 543).

So trimmen Sie einen Clip mit dem Trim-Tool:

1 Wählen Sie das Trim-Tool. 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie auf das Popup-Menü des Trim-
Tools und wählen Sie Standard.

• Klicken Sie mit der rechten Maustaste auf 
eine Spur und wählen Sie Tools > Trim 

Tools > Standard.

3 Bewegen Sie den Cursor an den Anfang oder 
das Ende eines Clips, um den Cursor des Trim-
Tools anzuzeigen.

Um die Richtung des Trim-Tools zu ändern, 
drücken Sie die Alt-Taste (Windows) bzw. 
die Wahltaste (Mac).

4 Sie haben folgende Möglichkeiten:

• Wenn Sie das Ende des Clips trimmen möchten, 
ziehen Sie den Cursor nach links zum Verkürzen 
des Clips bzw. nach rechts zum Verlängern 
des Clips.

• Wenn Sie den Anfang des Clips trimmen 
möchten, ziehen Sie den Trimmer nach rechts, 
um den Clip zu verkürzen, bzw. nach links, 
um den Clip zu verlängern.

Wenn Sie Clips in einer Stereo- oder 
Mehrkanalspur trimmen, werden alle 
Kanäle getrimmt.

Im Shuffle-Modus werden nachfolgende Clips 
wenn nötig so verschoben, dass Platz für den 
bearbeiteten Clip entsteht. Im Grid-Modus rastet 
der Start- bzw. Endpunkt beim Ziehen automatisch 
am nächstgelegenen Rasterpunkt ein. Im Spot-
Modus öffnet sich das Spot-Dialogfeld, in das Sie 
die neue Position des Anfangs- bzw. Endpunkts 
des Clips eingeben können.

Mit dem Trim-Tool können Sie auch MIDI-
Noten verlängern oder verkürzen (siehe 
„Trimmen der Anfangs- und Endpunkte von 
Noten“ auf Seite 704) sowie Automations- 
und Controller-Daten nach oben oder unten 
skalieren. Siehe „Zeichnen von 
Automationsdaten“ auf Seite 1100.

Trim-Tool

Trim-Tool

Beim Arbeiten mit Audio-Dateien können Sie 
einen Clip nicht über die Grenzen von 
benachbarten Clips hinaus trimmen.
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Time Compression/ 
Expansion-Trim-Tool
Das Time Compression/Expansion-Trim-Tool 
(TCE-Trim) ist ein Werkzeug, mit dem Sie auf 
bequeme Weise die Länge eines Audioclips an die 
Länge eines anderen Clips, eines Temporasters, 
einer Videoszene oder eines beliebigen anderen 
Referenzbereichs anpassen können.

Elastic Audio-TCE-Trim-Tool
Bei Elastic Audio-fähigen Spuren verwendet das 
TCE-Tool das ausgewählte Elastic Audio-Plug-In 
(Echtzeit oder gerendert) der Spur, um in Echtzeit 
oder gerenderte Elastic Audio-Verarbeitung 
anzuwenden. Im generierten Clip wird eine Warp-
Anzeige für die Elastic Audio-Verarbeitung 
angezeigt.

TCE-Trim-Tool für AudioSuite
Bei Audiospuren ohne Elastic Audio-Aktivierung 
funktioniert das Time Compression/Expansion-
Trim-Tool durch die Verwendung des AudioSuite-
Plug-Ins „Time Compression/Expansion (TCE)“, 
das in den Pro Tools-Voreinstellungen für die 
Verarbeitung ausgewählt wird, um eine neue 
Audiodatei zu erstellen. 

Einstellungen für das Time 
Compression/Expansion-Plug-In
Sie können auswählen, welches AudioSuite-Plug-
In zum Trimmen mit dem TCE-Trim-Tool bei 
Audiospuren verwendet wird, die nicht für Elastic 
Audio aktiviert sind. 

So legen Sie das AudioSuite-Plug-In für den 
Einsatz mit dem TCE-Trim-Tool fest:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Processing-Registerkarte.

3 Wählen Sie im TC/E Plug-In-Popup-Menü das 
AudioSuite-Plug-In zur Verwendung mit dem 
Time Compression/Expansion-Trim-Tool.

4 Wählen Sie im Default Settings-Popup-Menü 
die Plug-In-Einstellung aus, die für das 
Material, mit dem Sie vorwiegend arbeiten, am 
besten geeignet ist (etwa Stereo Mix Default).

5 Klicken Sie auf OK.

Time Compression/Expansion-Trim-Tool über 
einem Clip

Das TCE-Trim-Tool löst den Loop auf und 
führt Loop-Clips zusammen.

Sie können eine Edit-Selektion an die Länge 
einer Timeline-Selektion anpassen, indem Sie 
den Befehl „Edit > TCE Edit to Timeline 
Selection“ auswählen (siehe „TCE (Time 
Compression and Expansion) Edit To Timeline 
Selection“ auf Seite 622).

Weitere Informationen zu Elastic Audio-
Plug-Ins finden Sie unter „Elastic Audio-
Plug-Ins“ auf Seite 913.

 TC/E-Voreinstellungen

Weitere Informationen zu AudioSuite-
Plug-Ins finden Sie unter Kapitel 39: 
„AudioSuite“.
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TCE-Trim-Tool im Grid-Modus 
verwenden
Das TCE-Trim-Tool kann im Grid-Modus dazu 
verwendet werden, das Audiomaterial eines Clips 
an das Tempo einer Session oder eines Session-
Abschnitts anzupassen. Nehmen wir etwa an, Sie 
möchten einen eintaktigen Schlagzeug-Loop mit 
einem Tempo von 90 BPM in eine Session mit 
120 BPM importieren. Im Grid-Modus können Sie 
den Schlagzeug-Loop mit diesem Tool einfach, 
schnell und mit keinen oder minimalen 
Klangverlusten auf die Länge eines Takts 
komprimieren. 

So verwenden Sie das TCE-Trim-Tool im Grid-
Modus:

1 Setzen Sie den Edit-Modus auf „Grid“.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie auf das Popup-Menü des Trim-
Tools und wählen Sie TCE.

• Klicken Sie mit der rechten Maustaste auf eine 
Spur und wählen Sie Tools > Trim Tools > TCE.

3 Verschieben Sie den Start- oder Endpunkt 
des Audio-Clips mit dem TCE-Trim-Tool, 
um en Clip entsprechend dem Raster 
(etwa um Viertelnoten) zu komprimieren 
oder zu erweitern. 

TCE-Trim-Tool im Slip-Modus 
verwenden

So verwenden Sie das TCE-Trim-Tool im Slip-
Modus

1 Setzen Sie den Edit-Modus auf „Slip“.

2 Klicken Sie auf das Popup-Menü des Trim-
Tools und wählen Sie TCE.

3 Verschieben Sie den Start- oder Endpunkt des 
Clips mit dem TCE-Trim-Tool, um den Clip 
beliebig zu erweitern oder zu komprimieren. 

TCE-Trim-Tool im Spot-Modus 
verwenden
Wenn Sie im Spot-Modus mit dem TCE-Trim-
Tool auf einen Clip klicken, wird das Spot-
Dialogfeld geöffnet. Sie können den Start- oder 
Endpunkt des Clips oder seine Länge festlegen, 
und der Clip wird automatisch wie angegeben 
komprimiert oder gedehnt.

So verwenden Sie das TCE-Trim-Tool im Spot-
Modus:

1 Setzen Sie den Edit-Modus auf „Spot“.

2 Klicken Sie auf das Popup-Menü des Trim-
Tools und wählen Sie TCE.

3 Klicken Sie auf den Clip in der Nähe des Start- 
oder Endpunkts. Das Spot-Dialogfeld wird 
geöffnet. Geben Sie unter Verwendung einer 
beliebigen Zeitskala einen neuen Start- oder 
Endpunkt (bzw. eine neue Länge) für den Clip 
ein und klicken Sie dann auf „OK“. 

Durch das Trimmen von Clips im Relative 
Grid-Modus werden die Clips in Grip-
Schritten getrimmt, während ihr relativer 
Offset (falls vorhanden) zum Raster 
beibehalten wird.

Time Compression/Expansion-Trim-Tool
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Scrub-Trim-Tool
(Nur Pro Tools HD)

Mit dem Scrub-Trim-Tool kann Audiomaterial 
(auf bis zu zwei Spuren) abgehört werden, um eine 
zum Trimmen geeignete Position ausfindig zu 
machen. Sie können den Scrub-Trimmer über eine 
Spur ziehen, um das Audiomaterial abzuhören. 
Wenn Sie die geeignete Position gefunden haben, 
lassen Sie die Maustaste los und das Material wird 
an dieser Position getrimmt.

Durch diesen Vorgang wird ein neuer Clip erzeugt. 
Das Scrub-Trim-Tool verwandelt sich in einen 
nach rechts oder nach links gerichteten Trimmer, 
wenn es über der rechten oder linken Seite eines 
Clips positioniert wird. Um die Richtung des 
Scrub-Trim-Tools zu ändern, drücken Sie die Alt-
Taste (Windows) bzw. die Wahltaste (Mac), bevor 
Sie auf den Clip klicken.

Wiedergabegeschwindigkeit und -richtung 
verändern sich beim Scrubben entsprechend der 
Mausbewegung. Das Audiomaterial wird auf den 
Signalpfad der Spur geroutet, sodass Sie beim 
Scrubben auch eventuell eingerichtete Plug-In-
Effekte hören können.

So hören Sie eine Spur mit dem Scrub-Trimmer ab:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf das Popup-Menü des Trim-
Tools und wählen Sie Scrub. 

• Klicken Sie mit der rechten Maustaste 
auf eine Spur und wählen Sie Tools > 

Trim Tools > Scrub.

Das Tool verwandelt sich in ein Lautsprecher-
symbol mit einer eckigen Klammer.

2 Ziehen Sie den Cursor innerhalb einer Spur 
nach rechts oder links. Das Audiomaterial der 
Spur einschließlich aller DSP-Effekte wird auf 
den Signalpfad der Spur geroutet. Wenn Sie die 
Position zum Trimmen gefunden haben, lassen 
Sie die Maustaste los und der Clip wird an 
dieser Position getrimmt.

• Um zwei Spuren gleichzeitig mit dem Scrub-
Trim-Tool zu bearbeiten, klicken Sie mit dem 
Tool zwischen zwei benachbarte Spuren und 
ziehen es nach links oder rechts.

• Um in einer feineren Auflösung zu scrubben 
(ohne zu zoomen), halten Sie die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac) 
gedrückt, während Sie mit dem Scrub-Trim-
Tool arbeiten.

Scrub-Trim-Tool über einem Clip
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Loop-Trim-Tool
Verwenden Sie das Loop-Trim-Tool, um Loop-
Clips zu erstellen oder zu trimmen (siehe „Clip-
Loops“ auf Seite 873). 

Erstellen von Loops mit dem 
Loop-Trim-Tool

So erstellen Sie Loop-Clips mit dem Loop-Trim-
Tool:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf das Popup-Menü des Trim-
Tools und wählen Sie Loop.

• Klicken Sie mit der rechten Maustaste auf eine 
Spur und wählen Sie Tools > Trim Tools > Loop.

2 Positionieren Sie den Cursor über der oberen 
Hälfte eines Audio- oder MIDI-Clips bzw. einer 
Clipgruppe ohne Loop. Die Cursor-Darstellung 
ändert sich und zeigt an, dass Sie den Clip 
mithilfe von Loops trimmen können. 
(Durch Positionieren des Cursors über der 
unteren Hälfte des Clips wird er zum Standard-
Trim-Cursor)

3 Sie haben folgende Möglichkeiten:

• Klicken Sie am Ende des Clips und ziehen Sie 
nach links oder nach rechts bis zu der Position, 
an der der Loop enden soll.

• Klicken Sie am Anfang des Clips und ziehen Sie 
nach links oder nach rechts bis zu der Position, 
an der der Loop beginnen soll.

Trimmen von Loop-Clips
Sie können Loop-Clips auf zwei Arten trimmen:

• Trimmen Sie einen Loop-Clip, um die Dauer der 
Loops für den Clip zu ändern. Sie können 
beispielsweise einen Loop-Clip von zwei Takten 
auf vier Takte trimmen. Bei einem Clip mit 
einen Takt wird die Anzahl von Loops von zwei 
auf vier geändert. Jede Loop-Wiederholung 
behält die gleiche Länge bei, aber die Länge des 
gesamten Loop-Clips ändert sich.

• Trimmen Sie den Quellclip (Loop-
Wiederholung), ohne die Gesamtlänge des 
Loops zu ändern. Die Anzahl der Loop-
Wiederholungen im Loop-Clip ändert sich 
entsprechend. Trimmen Sie beispielsweise eine 
2-taktige Loop-Wiederholung eines 4-taktigen 
Loop-Clips auf einen Takt. Der 4-taktige Loop-
Clip bleibt konstant, die Anzahl von Loop-
Wiederholungen ändert sich aber von 2 auf 4. 
Die Länge der einzelnen Loop-Wiederholungen 
ändert sich, doch die Dauer der Loops für den 
Clip bleibt unverändert.

Loop-Trim-Tool

Loop Trim-Cursor

Loop-Clip

Loop-Trim-Tool

Loop-Symbol
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So trimmen Sie einen Loop-Clip mithilfe des Loop-
Trim-Tools:

1 Wählen Sie das Loop-Trim-Tool.

2 Bewegen Sie den Cursor über die obere Hälfte 
des Loop-Clips (nicht über ein Loop-Symbol). 
Der Cursor kennzeichnet das Loop-Trim-Tool.

3 Trimmen Sie den Loop-Clip.

Die Anzahl der Loops steigt oder fällt, um die neue 
Länge des gesamten Loop-Clips zu füllen.

So trimmen Sie den Quellclip (Loop-
Wiederholung) eines Loop-Clips:

1 Wählen Sie das Loop-Trim-Tool.

2 Bewegen Sie den Cursor über ein Loop-Symbol 
im Loop-Clip oder den unteren Bereich des 
Clips. Der Cursor kennzeichnet das Symbol des 
Trim-Tools.

3 Trimmen Sie den Anfang oder das Ende der 
Loop-Wiederholung.

Die Anzahl der getrimmten Loop-Wiederholungen 
steigt oder fällt, um die ursprüngliche Länge des 
gesamten Loop-Clips zu füllen.

Loop-Trim-Tool

Trimmen eines Loop-Clips mithilfe des Loop-
Trim-Tools

Halten Sie beim Trimmen die Windows-
Taste (Windows) bzw. die Ctrl-Taste 
(Mac) gedrückt, wenn Sie in Loop-
Wiederholungsschritten trimmen 
möchten.

Beim Trimmen eines Loop-Clips werden 
darin enthaltene Fades nicht getrimmt.

Loop-Trim-Tool

Trimmen eines Loop-Clips

Getrimmter Loop-Clip
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Verwenden des 
Selector-Tools
Verwenden Sie das Selector-Tool, um den Edit-
Cursor in einer Spur oder einer Zeitbasis-Leiste zu 
platzieren oder um eine Timeline- oder Edit-
Selektion auf Spuren auszuführen.

Platzieren des Edit-Cursors

So platzieren Sie den Edit-Cursor mit dem 
Selector-Tool:

1 Wählen Sie das Selector-Tool im Edit-Fenster.

2 Klicken Sie auf einer Spur oder einer Zeitbasis-
Leiste auf die Position.

Ausführen einer Edit-Selektion 
mit dem Selector-Tool

So nehmen Sie eine Edit-Selektion über das 
Selector-Tool vor:

1 Wählen Sie das Selector-Tool im Edit-Fenster.

2 Sie haben folgende Möglichkeiten:

• Um eine Edit-Selektion in einer Spur 
vorzunehmen, ziehen Sie die Maus in der Spur.

• Um eine Edit-Selektion für mehrere Spuren 
vorzunehmen, ziehen Sie die Maus über 
die Spuren.

• Wenn „Link Timeline and Edit Selection“ 
aktiviert ist, ziehen Sie die Maus auf der 
Zeitbasis-Leiste, um eine Edit-Selektion für alle 
Spuren vorzunehmen.

So selektieren Sie einen gesamten Clip mit dem 
Selector-Tool:

1 Wählen Sie das Selector-Tool im Edit-Fenster.

2 Doppelklicken Sie auf einen Clip in einer Spur.

So selektieren Sie eine gesamte Spur mit dem 
Selector-Tool:

1 Wählen Sie das Selector-Tool im Edit-Fenster.

2 Klicken Sie dreimal auf die Spur.

Vornehmen einer Timeline-
Selektion mit dem Selector-Tool

So nehmen Sie eine Timeline-Selektion über das 
Selector-Tool vor:

1 Wählen Sie das Selector-Tool im Edit-Fenster.

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie die Maus auf eine Zeitbasis-Leiste.

• Wenn „Link Timeline and Edit Selection“ 
aktiviert ist, ziehen Sie die Maus in einer Spur.

Platzieren des Edit-Cursors mit dem Selector-Tool

Vornehmen einer Selektion über das Selector-Tool
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Verwenden des Grabber-Tools
Verwenden Sie die Grabber-Tools, um Clips auf 
Spuren zu selektieren, zu verschieben, zu trennen 
oder anzuordnen. Für das Grabber-Tool gibt es 
drei Modi: Time Grabber, Separation Grabber und 
Object Grabber. Weitere Informationen zum 
Anordnen von Clips finden Sie auch unter 
Kapitel 37: „Anordnen von Clips“.

Time Grabber. – selektiert einen gesamten Clip auf 
einer Spur mit einem einzelnen Klick. Weitere 
Informationen zum Auswählen von Clips finden 
Sie unter „Selektieren von Spurmaterial“ auf 
Seite 577.

Separation Grabber. – schneidet mithilfe von 
Klicken und Ziehen eine Edit-Selektion an einer 
Position aus und fügt sie an einer anderen Position 
ein. Weitere Informationen dazu finden Sie unter 
„Separation Grabber-Tool“ auf Seite 602.

Object Grabber. – erlaubt das Selektieren 
mehrerer, nicht nebeneinanderliegender Clips. 
Weitere Informationen dazu finden Sie unter 
„Objektselektionen“ auf Seite 580.

Führen Sie einen der folgenden Schritte aus, 
um eines der Grabber-Tools auszuwählen:

 Klicken Sie im Edit-Fenster auf das Grabber-
Tool und wählen Sie das Grabber-Tool aus dem 
Popup-Menü aus.

 Klicken Sie mit der rechten Maustaste auf eine 
Spur und wählen Sie über Tools > Grabber 

Tools das Grabber-Tool aus.

Verwenden des Smart-Tools
Mit dem Smart-Tool können Sie direkt auf die 
Selector-, Grabber- und Trim-Tools zugreifen 
sowie Fades und Crossfades erzeugen. Die Cursor-
Position im Verhältnis zu einem Clip oder einer 
Note oder in einer automatischen Wiedergabeliste 
bestimmt, wie sich das Smart-Tool verhält.

Um das Smart-Tool zu aktivieren, klicken Sie 
oben links im Edit-Fenster auf die Smart-Tool-
Schaltfläche oder drücken Sie F6 + F7 
(oder F7 + F8).

Time Grabber-Tool

Separation Grabber-Tool

Object Grabber-Tool

Auswählen eines Grabber-Tools

Smart-Tool im Edit-Fenster aktiviert
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Smart-Tool in der Waveform-
Darstellung (Audio) oder der 
Clipdarstellung (MIDI)

Folgende Funktionen sind bei Verwendung des 
Smart-Tools verfügbar, wenn Audiospuren in der 
Waveform- oder Blockdarstellung bzw. MIDI- 
oder Instrumentenspuren in der Clipdarstellung 
verwendet werden:

 Positionieren Sie den Cursor im Selector-Tool 
in der oberen Hälfte des Clips über der Mitte 
des Clips.

 Positionieren Sie den Cursor im Grabber-Tool 
in der unteren Hälfte des Clips über der Mitte 
des Clips.

 Positionieren Sie den Cursor im Trim-Tool an 
den Anfang oder das Ende eines Clips. 

 Für einen Fade-In oder Fade-Out positionieren 
Sie den Cursor im oberen Abschnitt nahe dem 
Start- oder Endpunkt des Audioclips. Wenn der 
Fade-Cursor erscheint, ziehen Sie ihn in den Clip, 
um die Fade-Länge festzulegen. Der Fade wird 
automatisch gemäß den Voreinstellungen für 
Fades erstellt, die in den Editing-Voreinstellungen 
geändert werden können.

 Für einen Crossfade positionieren Sie den 
Cursor im unteren Abschnitt zwischen zwei 
angrenzenden Audio-Clips. Sobald der Crossfade-
Cursor erscheint, ziehen Sie ihn nach links oder 
rechts, um die Länge des Crossfades festzulegen. 

Der Crossfade wird automatisch gemäß den 
Voreinstellungen für Fades erstellt, die in 
den Editing-Voreinstellungen verändert 
werden können.

Smart-Tool in der Warp-
Darstellung

Folgende Funktionen sind bei Verwendung des 
Smart-Tools verfügbar, wenn Audiospuren mit 
aktiviertem Elastic Audio in der Warp-Darstellung 
bzw. MIDI- oder Instrumentenspuren in der 
Clipdarstellung verwendet werden:

 Positionieren Sie den Cursor im Selector-Tool 
in der oberen Hälfte des Clips über der Mitte 
des Clips.

 Positionieren Sie den Cursor im Grabber-Tool 
in der unteren Hälfte des Clips über der Mitte des 
Clips, jedoch nicht über einen Event-Marker oder 
Warp-Marker.

Smart-Tool in der Waveform-Darstellung

Fade In Fade OutSelector-Tool

Grabber-Tool

Trim-
Tool

(Start)

Trim-
Tool 

(Ende)

Crossfade

Um vorübergehend vom Smart-Tool zum 
Scrubber umzuschalten, platzieren Sie 
den Cursor auf dem Clip, sodass das 
Selector-Tool aktiviert ist, und drücken 
Sie dann die Windows-Taste (Windows) 
oder Ctrl-Taste (Mac).

Smart-Tool in der Warp-Darstellung

Selector-Tool

Grabber-Tool

Trim-
Tool

(Start)

Trim-
Tool 

(Ende)



Pro Tools-Referenzhandbuch568

 Positionieren Sie zum Warpen von Elastic 
Audio den Cursor auf einem Event-Marker oder 
einem Warp-Marker in der unteren Hälfte des 
Clips. (Weitere Informationen zum Warpen von 
Audio finden Sie unter „Editieren in der Warp-
Darstellung“ auf Seite 917.)

 Positionieren Sie den Cursor im Trim-Tool in 
der oberen Hälfte des Clips an den Anfang oder 
das Ende des Clips. 

Smart-Tool in der 
Notendarstellung

Folgende Funktionen sind bei Verwendung 
des Smart-Tools verfügbar, wenn MIDI- und 
Instrumentenspuren in der Notendarstellung im 
Edit-Fenster und in den MIDI Editor-Fenstern 
verwendet werden:

 Um den Fadenkreuz-Selektor aufzurufen, 
positionieren Sie den Cursor so, dass er keine 
Noten verdeckt.

 Um das Grabber-Tool aufzurufen, positionieren 
Sie den Cursor über den mittleren Bereich 
einer Note. 

 Positionieren Sie den Cursor im Trim-Tool am 
Anfang oder Ende einer Note.

 Um das Velocity-Trim-Tool aufzurufen, 
positionieren Sie den Cursor über der Note und 
drücken Sie die Strg-Taste (Windows) bzw. 
die Befehlstaste (Mac).

Smart-Tool in den Darstellungen 
„Automation“ und „Controller“
Folgende Funktionen sind bei der Verwendung des 
Smart-Tools in den Darstellungen „Automation“ 
und „Controller“ verfügbar:

 Positionieren Sie den Cursor in den unteren 
75 % der Playlist, um das Selector-Tool zu 
aufzurufen. Ziehen Sie dann das Selector-Tool 
zur Auswahl von Breakpoints. 

Um vorübergehend vom Smart-Tool zum 
Scrubber umzuschalten, platzieren Sie den 
Cursor in der oberen Hälfte des Clips, 
sodass das Selector-Tool aktiviert ist, 
und drücken Sie dann die Windows-Taste 
(Windows) oder Ctrl-Taste (Mac).

Smart-Tool in der Notendarstellung

Selector-Tool (Fadenkreuz)

Grabber-ToolStart der 
Trim-Note

Ende der 
Trim-Note

Trimmen der Velocity-Werte einer Note

Um vorübergehend vom Smart-Tool auf 
das Pencil-Tool umzuschalten, drücken 
Sie die Windows-Taste (Windows) bzw. 
die Ctrl-Taste (Mac). 

Um vorübergehend vom Smart-Tool 
zum Eraser umzuschalten, drücken Sie 
Alt + Windows (Windows) bzw. Wahl + 
Ctrl (Mac). 
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 Um die Trim-Tools aufzurufen, positionieren 
Sie den Cursor in den oberen 25 % der Playlist. 
Ziehen Sie dann das Trim-Tool zum Trimmen von 
Breakpoints. Halten Sie die Strg-Taste (Windows) 
bzw. die Befehlstaste (Mac) während des 
Trimmens zur Feinsteuerung gedrückt.

 Drücken Sie zum Aufrufen der Grabber-Tools 
die Strg-Taste (Windows) bzw. die Befehlstaste 
(Mac) und klicken Sie dann auf die Automation-
Linie, um Breakpoints zu erstellen.

• Um bereits bestehende Breakpoints editieren 
zu können, bewegen Sie den Cursor in die Nähe 
eines Breakpoints, woraufhin das Grabber-
Tool erscheint.

• Zur Feinsteuerung mit dem Grabber-Tool 
drücken Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) oder halten Sie diese Tasten 
zur Erstellung eines neuen Breakpoints 
gedrückt. 

• Für ausschließlich vertikale Bewegungen 
drücken Sie die Umschalttaste.

• Für ausschließlich vertikale Bewegungen mit 
dem Grabber-Tool bei gleichzeitiger 
Feinsteuerung drücken Sie Strg + Umschalt 
(Windows) bzw. Befehl + Umschalt (Mac). 

Verwendung des Smart-Tools 
mit Stereo- und 
Mehrkanalspuren
Beim Verwenden des Smart-Tools können Clips 
auf einzelnen Kanälen innerhalb von Stereo- und 
Mehrkanalspuren nicht unabhängig voneinander 
selektiert werden. Alle Bearbeitungsschritte 
beeinflussen die Kanäle als Einheit. 

Bei Stereo- und Mehrkanalspuren wird das 
Wechseln zwischen den Tools für das Smart-Tool 
durch die Position in der gesamten Spur bestimmt, 
nicht durch die Position innerhalb einzelner Kanäle.

Verwenden des Scrubber-
Tools
Mit dem Scrubber-Tool können Sie im Edit-
Fenster bis zu zwei Audiospuren scrubben. 
Scrubbing ist eine Technik aus der Zeit des 
analogen Bandschnitts. Dabei wird das Band über 
den Playhead langsam vor- und zurückbewegt, 
um eine bestimmte Position zu finden (um dann 
das Band zu schneiden).

Obwohl die Audiowellenform in Pro Tools 
manchmal sehr hilfreich ist, um einen Edit-
Punkt zu finden, gibt es Situationen, in denen 
diese Darstellungsart sich aufgrund ihrer 
Klangeigenschaften nicht zum Schneiden eignet. 
Durch Scrubbing in beide Richtungen in Pro Tools 
können Sie das Material abhören und einen 
genauen Edit-Punkt finden. 

Ist auf der Operation Preferences-Registerkarte 
die Option „Edit Insertion Follows Scrub/Shuttle“ 
aktiviert, wird der Edit-Cursor automatisch an die 
Position bewegt, an der Sie das Scrubbing 
beendet haben.

Wenn die Option „Scrolling“ auf „Continuous“ 
(nur Pro Tools HD) oder „Center Playhead“ 
(nur Pro Tools HD) festgelegt ist, wird durch das 
Klicken mit dem Scrubber-Tool in die Playlist 
einer Spur das Edit-Fenster um diesen Punkt 
zentriert und der Playhead wird an diese Position 
verschoben. Das gescrubbte Material bewegt sich 
hinter den Playhead. Der Playhead bleibt in der 
Mitte des Bildschirms.

So scrubben Sie eine einzelne Audiospur:

1 Aktivieren Sie das Scrubber-Tool.

2 Ziehen Sie in der Spur: nach links, um rückwärts, 
oder nach rechts, um vorwärts zu scrubben.

Scrubbing einer Audiospur
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Die Strecke und die Geschwindigkeit der 
Ziehbewegung bestimmen die Länge und die 
Geschwindigkeit des gescrubbten Audiomaterials. 
Sie können zum Scrubbing entweder die Maus 
oder das Scrub-Rad einer Bedienoberfläche 
verwenden. Die Audiodaten der gescrubbten Spur 
werden zusammen mit den der Spur zugewiesenen 
Effekten auf den Ausgang geroutet.

Die Auflösung für den Scrubber ist abhängig vom 
Zoomfaktor für die Scrub-Spur.

Führen Sie einen der folgenden Schritte aus, 
um mehrere Audiospuren zu scrubben:

 Bewegen Sie den Scrubber zwischen zwei 
benachbarten Spuren.

 Scrubben Sie innerhalb einer Selektion, 
die mehrere Spuren enthält.

Beim Scrubben mehrerer Spuren werden nur die 
ersten beiden Spuren wiedergegeben.

Scrub/Shuttle-Modus
Bei normalem Scrubbing können Sie mit regulärer 
oder langsamer Wiedergabegeschwindigkeit 
arbeiten. Im Scrub/Shuttle-Modus ist dagegen ein 
sehr viel schnelleres Scrubbing möglich. Dies ist 
besonders dann hilfreich, wenn Sie lange 
Abschnitte nach Audiomaterial durchsuchen.

So scrubben Sie im Shuttle-Modus (mit höherer 
Geschwindigkeit):

1 Aktivieren Sie das Scrubber-Tool.

2 Ziehen Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) innerhalb der Spur 
nach links, um rückwärts, oder nach rechts, 
um vorwärts zu scrubben. Die Fast Forward- 
und Rewind-Schaltflächen im Transport-
Fenster werden aktiviert. 

Die Geschwindigkeit des gescrubbten 
Audiomaterials entspricht der Ihrer 
Mausbewegungen.

Shuttle Lock-Modus
Im Shuttle Lock-Modus können Sie mithilfe des 
Ziffernblocks bis zu zwei Spuren mit einer 
festgelegten Geschwindigkeit vorwärts oder 
rückwärts wiedergeben: 5 ist die 
Standardgeschwindigkeit, 6 bis 9 sind 
Vorspulgeschwindigkeiten (je höher die Zahl, 
desto höher die Vorspulgeschwindigkeit) und 4 bis 
1 sind Rückspulgeschwindigkeiten (wobei 4 die 
langsamste und 1 die schnellste Shuttle Lock-
Rückspulgeschwindigkeit ist). Wenn Sie mehrere 
Spuren selektiert haben, betrifft diese Funktion nur 
die ersten beiden.

Sie können kurzfristig vom Selector-Tool auf 
das Scrubber-Tool umschalten, indem Sie bei 
gedrückter Windows-Taste (Windows) bzw. bei 
gedrückter Ctrl-Taste (Mac) klicken. Um eine 
feinere Auflösung zu erhalten, klicken Sie, 
während Sie Strg + Windows (Windows) bzw. 
Befehl + Ctrl (Mac) drücken.

Scrubbing zwischen zwei Audiospuren

In Pro Tools können maximal acht Kanäle 
gescrubbt werden. Sie können also etwa 
eine 7.1-Spur oder zwei Stereospuren 
(vier Kanäle) scrubben, nicht aber zwei 
5.1-Surround-Spuren (12 Kanäle).
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So spielen Sie eine oder zwei Spuren im Shuttle 
Lock-Modus ab: 

1 Vergewissern Sie sich in Pro Tools HD, dass 
der Ziffernblockmodus in den Operation-
Voreinstellungen nicht auf „Shuttle“ gestellt ist 
(siehe „Operation Preferences“ auf Seite 108).

2 Klicken Sie mit dem Selector-Tool auf die 
Stelle in einer Spur, an der die Wiedergabe 
beginnen soll. Um zwei Spuren im Shuttle-
Modus wiederzugeben, klicken Sie bei 
gedrückter Umschalttaste auf eine zweite Spur.

3 Drücken Sie die Windows-Taste (Windows) 
bzw. die Ctrl-Taste (Mac) und eine Ziffer auf 
dem Ziffernblock: Die Ziffer 9 entspricht der 
höchsten Geschwindigkeit, 5 einer normalen, 
0 stoppt das Shuttling.

Nach dem Aktivieren des Shuttle Lock-Modus 
erscheinen die Fast Forward- und Rewind-
Schaltflächen im Transport-Fenster markiert.

4 Drücken Sie weitere Tasten, um die 
Wiedergabegeschwindigkeit zu ändern, oder 
drücken Sie die Plus-Taste (+) bzw. die Minus-
Taste (–), um die Richtung zu ändern (Plus-
Taste für vorwärts, Minus-Taste für rückwärts).

5 Um die Wiedergabe zu beenden, drücken Sie 
Windows + 0 (Windows) bzw. Ctrl + 0 (Mac).

Zum Beenden des Shuttle Lock-Modus wählen Sie 
eine der folgenden Methoden:

 Klicken Sie im Transport-Fenster auf „Stop“.

 Drücken Sie die Leertaste.

Custom Shuttle Lock Speed
(Nur Pro Tools HD)

Mit der Custom Shuttle Lock Speed-
Voreinstellung können Sie die größte 
Vorspulgeschwindigkeit im Shuttle Lock-Modus 
(Taste 9) an Ihre Anforderungen für das 
Bearbeiten und Abhören anpassen.

So konfigurieren Sie die Custom Shuttle Lock 
Speed-Voreinstellung:

1 Wählen Sie in Pro Tools Setup > Preferences 
und klicken Sie auf die Operation-
Registerkarte. 

2 Stellen Sie den Ziffernblockmodus auf 
Transport oder Classic (siehe „Operation 
Preferences“ auf Seite 108).

3 Geben Sie die gewünschte Einstellung der 
Custom Shuttle Lock Speed-Option mithilfe 
einer Prozentzahl an. Dieser Wert kann 
zwischen 50 und 800 % liegen. Verwenden Sie 
die Pfeiltaste nach oben oder nach unten, um die 
Einstellung zu erhöhen bzw. zu senken. 

4 Klicken Sie auf OK. 

Der Wert der Custom Shuttle Lock Speed-
Voreinstellung wird in den Pro Tools-
Voreinstellungen (und nicht mit der Session) 
gespeichert.

So aktivieren Sie die Custom Shuttle Lock 
Speed-Funktion:

 Drücken Sie Windows + 9 (Windows) bzw. 
Ctrl + 9 (Mac) auf dem Ziffernblock.
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Ziffernblock im Shuttle-Modus
(Nur Pro Tools HD)

Pro Tools bietet neben dem Shuttle Lock-Modus 
noch eine weitere Form des Shuttling. Ist der 
Ziffernblock im Shuttle-Modus, können Sie die 
Wiedergabe der aktuellen Edit-Selektion durch 
Drücken und Halten der entsprechenden Tasten 
des Ziffernblocks starten; sobald Sie die Tasten 
loslassen, wird die Wiedergabe gestoppt. Sowohl 
bei der Vorwärts- als auch bei der 
Rückwärtswiedergabe stehen verschiedene 
Geschwindigkeiten zur Verfügung. Pre- und Post-
Roll werden in diesem Modus ignoriert.

So arbeiten Sie mit der Shuttling-Funktion, 
wenn der Ziffernblockmodus auf „Shuttle“ 
eingestellt ist:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Stellen Sie als Ziffernblockmodus Shuttle ein 
und klicken Sie auf OK.

3 Klicken Sie mit dem Selector-Tool auf die 
Stelle in einer Spur, an der die Wiedergabe 
beginnen soll. Um zwei Spuren im Shuttle-
Modus wiederzugeben, klicken Sie bei 
gedrückter Umschalttaste auf eine zweite Spur.

4 Halten Sie eine der folgenden Tasten (oder 
Tastenkombinationen) auf dem Ziffernblock 
gedrückt, um die Wiedergabe zu starten.

5 Drücken Sie eine andere Taste, um die 
Wiedergaberichtung oder -geschwindigkeit 
zu ändern. Lassen Sie die Taste los, um die 
Wiedergabe zu beenden.

Verwenden des Pencil-Tools
Mit dem Pencil-Tool können Sie mehrere Typen 
von Pro Tools-Daten zeichnen:

• Audiowellenformen (siehe „Reparieren von 
Wellenformen mit dem Pencil-Tool“ auf 
Seite 572)

• MIDI-Daten (siehe „Verwenden des Pencil-
Tools“ auf Seite 696)

• Tempowechsel (siehe „Bearbeiten von Tempo-
Events im Tempo-Editor“ auf Seite 806)

• Automation (siehe „Zeichnen von 
Automationsdaten“ auf Seite 1100). 

Reparieren von Wellenformen 
mit dem Pencil-Tool
In Audiospuren können Sie mit dem Pencil-Tool 
Wellenformdaten destruktiv neu zeichnen. Dieses 
Tool wird häufig verwendet, um ein Knack- oder 
Klickgeräusch in einer Audiodatei zu beseitigen. 
Ein Knacken oder Klicken erscheint in der 
Wellenformdarstellung als plötzliche Pegelspitze. 
Das Tool wird nur aktiviert, wenn das Edit-Fenster 
auf Sample-Darstellung gezoomt wird.

Obwohl mit dem Pencil-Tool ausgeführte 
Editiervorgänge rückgängig gemacht werden 
können, empfehlen wir, zuvor eine Sicherungskopie 
des zu bearbeitenden Audiomaterials zu erstellen. 
Sie können dies mithilfe des AudioSuite Duplicate-
Plug-Ins tun.

Shuttle-
Geschwindigkeit

Rewind-
Taste

Forward-
Taste

1fach 4 6

4fach 7 9

1/4fach 1 3

1/2fach 4 + 5 5 + 6

2fach 7 + 8 8 + 9

Das Pencil-Tool ist eine destruktive Edit-
Funktion, die auf der Festplatte gespeicherte 
Audiodateien dauerhaft ändert und daher mit 
Vorsicht verwendet werden sollte.

Informationen zum AudioSuite Duplicate-
Plug-In finden Sie im Audio Plug-Ins 
Guide.
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So editieren Sie destruktiv eine Audiowellenform 
mit dem Pencil-Tool:

1 Suchen Sie den Bereich, den Sie 
editieren möchten.

2 Verwenden Sie das Zoomer-Tool oder die 
Zoomschaltflächen, um auf Sample-
Darstellungsgröße zu zoomen, sodass die 
Wellenform als ununterbrochene dünne Linie 
erscheint. Passen Sie die Spurhöhe (Track 
Height) an, um die Wellenform präziser 
bearbeiten zu können. Für eine bessere 
grafische Auflösung können Sie auch den 
vertikalen Zoom verwenden.

3 Aktivieren Sie das Pencil-Tool.

4 Zeichnen Sie mit dem Pencil-Tool vorsichtig 
über den Bereich der Wellenform.

Bearbeiten Sie die Wellenform nicht zu stark, 
da dies zu unerwünschten Ergebnissen führen 
kann. Sie können jedoch den Undo-Befehl 
verwenden, um die jeweils vorangegangene 
Änderung rückgängig zu machen.

Mit dem Pencil-Tool können Sie verschiedene 
Kanäle einer Mehrkanalspur unabhängig 
bearbeiten. 

Versuchen Sie, sich bei der Bearbeitung auf einen 
möglichst kleinen Bereich zu beschränken, 
und orientieren Sie sich am Verlauf der bereits 
vorhandenen Wellenform. 

Edit/Tool Mode 
Keyboard Lock
Aktivieren Sie Options > Edit/Tool Mode Keyboard 

Lock, um die zurzeit ausgewählten Edit-Tools (nur 
Zoom, Trim, Grabber und Pencil) zu sperren und 
zu verhindern, dass Sie diese beim Arbeiten mit 
Tastenkombinationen versehentlich ändern. Wenn 
die Option Edit/Tool Mode Keyboard Lock aktiviert 
ist, haben Sie dennoch die Möglichkeit, den Typ 
des Edit-Tools zu wechseln. Verwenden Sie dazu 
entweder die Maus oder das Kontextmenü. 
Außerdem können Sie mit Tastenkombinationen 
zwischen Tools umschalten (etwa vom Grabber 
zum Trim wechseln).

So sperren (oder entsperren) Sie die aktuellen 
Edit-Tool-Modi:

1 Wählen Sie die gewünschten Edit-Tool-Modi 
(etwa Standard Trim-Tool, Time Grabber-Tool 
und Pencil-Tool „Free Hand“). 

2 Aktivieren (oder deaktivieren) Sie Options > 

Edit/Tool Mode Keyboard Lock.

Sie können Darstellungsgrößen der Spur mit 
den Zoomvoreinstellungs-Schaltflächen 
(siehe „Zoomoptionen“ auf Seite 548) 
oder mit den entsprechenden Memory 
Locations (siehe „Aufrufen von Memory 
Locations“ auf Seite 843) wieder 
aufrufen. Die Standardeinstellung für die 
Zoomvoreinstellung 5 ist bei der Bearbeitung 
mit dem Pencil-Tool die Sample-Darstellung.

Pencil-Tool

Reparieren eines Knackgeräuschs mit dem 
Pencil-Tool
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Kapitel 26: Auswählen einer Selektion

Das Edit-Fenster von Pro Tools bietet viele Tools 
zum Selektieren von Material.

Koppeln und Entkoppeln 
von Timeline- und Edit-
Selektionen
In Pro Tools ist es möglich, Timeline- und Edit-
Selektionen zu koppeln und zu entkoppeln. 

Wenn Timeline- und Edit-Selektion miteinander 
verknüpft sind, wird durch Auswählen in der 
Playlist einer Spur (eine Edit-Selektion) auch der 
Wiedergabe- und Aufnahmebereich festgelegt 
(die Timeline-Selektion).

Wenn Sie Timeline- und Edit-Selektion 
entkoppeln, können Sie auf einer Spur zum 
Editieren eine Selektion vornehmen, die sich 
von der Selektion in der Timeline (legt die 
Wiedergabe- und Aufnahmebereiche fest) 
unterscheidet.

Führen Sie einen der folgenden Schritte aus, 
um Timeline- und Edit-Selektion zu koppeln 
oder zu entkoppeln:

 Aktivieren oder deaktivieren Sie Options > 

Link Timeline and Edit Selection.

 Klicken Sie im Edit-Fenster, in einem MIDI 
Editor-Fenster oder im Score Editor-Fenster 
auf die Link Timeline and Edit Selection-
Schaltfläche, sodass sie hervorgehoben 
(aktiviert) bzw. nicht hervorgehoben 
(nicht aktiviert) ist. Das Aktivieren oder 
Deaktivieren der Schaltfläche „Link Timeline 
and Edit Selection“ in einem Editor-Fenster 
hat Auswirkungen auf alle Editor-Fenster.

Schaltfläche „Link Timeline and Edit Selection“ 
aktiviert im Edit-Fenster

Drücken Sie die Umschalttaste und den 
Schrägstrich (/), um „Link Timeline 
and Edit Selection“ zu aktivieren oder 
zu deaktivieren.
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Wenn Sie an einer Film- oder Videoszene arbeiten, 
werden Sie wahrscheinlich die Timeline- und Edit-
Selektion entkoppeln, um Material zu suchen 
oder abzuhören, das sich nicht in der aktuellen 
Timeline-Selektion befindet. Sie können eine Edit-
Selektion ohne Auswirkungen auf die aktuelle 
Timeline-Selektion wiedergeben (wählen Sie 
hierzu Edit > Selection > Play Edit). Sobald Sie 
das Material gefunden haben, können Sie zur 
Timeline-Selektion zurückkehren und das 
Material in der Szene positionieren.

Die folgende Abbildung zeigt einen weiteren 
Grund, warum die Entkopplung von Timeline- 
und Edit-Selektion sinnvoll ist. In diesem Beispiel 
legt die Timeline-Selektion einen Bereich fest, 
der im Loop abgespielt werden soll, während 
ein MIDI-Clip (in diesem Loop) zum Editieren 
selektiert wurde. 

Während der Wiedergabe kann die Edit-
Selektion mit der Nudge-Funktion verschoben, 
quantisiert oder transponiert werden, ohne dass die 
Wiedergabe des Loops davon beeinträchtigt wird.

Dies ist theoretisch auch mit gekoppelter 
Timeline- und Edit-Selektion möglich; in diesem 
Fall würde der Wiedergabebereich jedoch nach 
dem Wiedergabestopp auf einen zeitlich kurz 
zurückliegenden Bearbeitungsbereich oder 
(beim Bearbeiten von MIDI-Material) auf eine 
einzelne Note aktualisiert werden.

Marker für die Timeline- und 
Edit-Selektion
Die Timeline-Selektion wird in der Haupt-
Zeitbasis-Leiste mit Markern für die Timeline-
Selektion angezeigt, die als blaue Pfeile erscheinen 
(bei der Aufnahme rot). Darüber hinaus gibt es Pre- 
und Post-Roll-Flags (nach der Aktivierung grün), 
welche die Position für Pre- und Post-Roll anzeigen.

Wenn Timeline- und Edit-Selektion nicht 
gekoppelt sind, wird die Edit-Selektion in der 
Leiste zusammen mit Edit-Markern angezeigt, 
die als schwarze Klammern erscheinen.

Sind Timeline- und Edit-Selektion dagegen 
gekoppelt, wird die Edit-Selektion durch blaue 
Marker für die Timeline-Selektion dargestellt.

Weitere Informationen zum Arbeiten mit der 
Timeline- und der Edit-Selektion finden Sie unter:

• „Selektieren von Spurmaterial“ auf Seite 577

• „Timeline-Selektionen“ auf Seite 588

• „Festlegen der Punch- und Loop-Punkte“ auf 
Seite 459

• „Einstellen von Pre- und Post-Roll“ auf 
Seite 463

Timeline- und Edit-Selektion (entkoppelt)

Marker für die Timeline-Selektion mit Pre- und Post-
Roll-Flags

Edit-Marker
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Koppeln und Entkoppeln von 
Spur- und Edit-Selektion
Mit Pro Tools ist es möglich, die Spurselektion mit 
der Edit-Selektion zu koppeln und zu entkoppeln.

Wenn Spur- und Edit-Selektionen gekoppelt 
werden, können Sie eine Selektion innerhalb 
einer Spur oder über mehrere Spuren hinweg 
zum Bearbeiten vornehmen. Dabei wird jede 
zugehörige Spur selektiert (Spurnamen werden 
automatisch hervorgehoben). Damit können 
Sie Befehle auf der Spurebene schnell anwenden 
(beispielsweise das Wechseln der Spurdarstellung 
oder das Ändern der Spurhöhe) und den Befehl auf 
alle Spuren anwenden, mit denen Sie arbeiten. 

Bei entkoppelter Spur- und Edit-Selektion werden 
durch eine Edit-Selektion nicht automatisch alle 
assoziierten Spuren selektiert. 

So koppeln (oder entkoppeln) Sie die Spur- und 
Edit-Selektionen:

 Aktivieren oder deaktivieren Sie Options > Link 

Track and Edit Selection.

 Klicken Sie oben links im Edit-Fenster unter 
den Edit-Tools auf die Link Track and Edit 
Selection-Schaltfläche, sodass diese 
hervorgehoben (aktiviert) bzw. nicht 
hervorgehoben (nicht aktiviert) wird.

Selektieren von Spurmaterial
Um Audio- und MIDI-Material editieren zu 
können, müssen Sie es zunächst selektieren. 
Die Spurdarstellung bestimmt, wie das Material 
angezeigt und selektiert wird. 

Eine Selektion wird innerhalb der Spur markiert 
und durch blaue Pfeile am Start und am Ende 
(Marker für die Timeline-Selektion) in der Haupt-
Zeitbasis-Leiste angezeigt. Wenn eine Audio- oder 
MIDI-Spur in der Session aufnahmebereit ist, 
erscheinen diese Marker rot (auch wenn die Spur 
ausgeblendet ist). 

Wenn Timeline- und Edit-Selektion nicht 
gekoppelt sind, wird der Bereich der Edit-
Selektion in der Haupt-Zeitbasis-Leiste durch 
Edit-Marker angezeigt. Weitere Hinweise finden 
Sie unter „Koppeln und Entkoppeln von Timeline- 
und Edit-Selektionen“ auf Seite 575.

Selektionen und Edit-Gruppen

Wenn Sie Selektionen in Spuren vornehmen, 
die Teil einer Edit-Gruppe sind, werden alle 
Spuren innerhalb dieser Gruppe selektiert.

„Link Track and Edit Selection“ aktiviert

Marker für die Timeline-Selektion kennzeichnen die 
Edit-Selektion
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Selektionen und ausgeblendete Spuren

Beim Editieren von Spuren, die zu einer aktiven 
Edit-Gruppe gehören, bleiben alle ausgeblendeten 
Spuren unverändert. Um alle Spuren einer Gruppe 
editieren zu können, müssen Sie sicherstellen, dass 
diese Spuren sichtbar sind, indem Sie ihre Namen 
in der Tracks-Liste markieren. 

Selektionen auf mehreren Spuren

So nehmen Sie eine Selektion auf mehreren 
Spuren vor:

 Ziehen Sie mit dem Selector-Tool vertikal, 
um angrenzende Spuren in die Selektion 
einzubeziehen. (Wenn Sie horizontal ziehen, 
definieren Sie den Zeitbereich.) 

Selektieren von Clips

So selektieren Sie einen Bereich eines Clips:

 Ziehen Sie mit dem Selektor-Tool in dem Clip 
(nach links oder rechts), um das Material auf 
einer Spur zu selektieren. (Sie können mit dem 
Selector-Tool auch Bereiche auf mehreren 
benachbarten Spuren selektieren.)

So selektieren Sie einen vollständige Clip:

 Klicken Sie den Clip mit dem Time Grabber-
Tool an.

 Doppelklicken Sie mit dem Selektor-Tool auf 
den Clip.

So selektieren Sie zwei Clips und den 
dazwischenliegenden Zeitbereich:

1 Klicken Sie mit dem Time Grabber auf den 
ersten Clip.

2 Klicken Sie bei gedrückter Umschalt-Taste auf 
den zweiten Clip. Beide Clips und der 
dazwischen liegende Bereich (inklusive 
weiterer Clips) werden selektiert.

So selektieren Sie eine vollständige Spur:

 Klicken Sie mit dem Selector-Tool auf eine 
Spur und wählen Sie Edit > Select All.

 Klicken Sie mit dem Selector-Tool dreimal auf 
die Spur.

So selektieren Sie alle Clips auf allen Spuren:

1 Wählen Sie im Groups-Listen-Popup-Menü die 
Edit-Gruppe „All“.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Selector-Tool auf eine 
beliebige Spur und wählen Sie Edit > Select All.

• Klicken Sie mit dem Selector-Tool dreimal auf 
eine beliebige Spur.

Auswahl eines Bereichs eines Clips

Drücken Sie Strg + A (Windows) 
bzw. Befehl + A (Mac).

Sie können auch ohne Auswählen der Edit-
Gruppe „All“ alle Clips in allen Spuren 
selektieren, indem Sie die Eingabetaste 
(Windows) bzw. die Return-Taste (Mac) 
drücken und dann Strg + A (Windows) 
bzw. Befehl + A (Mac). Die Option „Link 
Timeline and Edit Selection“ muss 
aktiviert sein.
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Clip List Selection Follows 
Edit Selection
Ist in den Editing-Voreinstellungen Clip List 
Selection Follows Edit Selection aktiviert, wird 
beim Selektieren eines Clips in einer Spur dieser 
auch in der Clipliste selektiert.

Ist dagegen auf derselben Registerkarte die Option 
Edit Selection Follows Clip List Selection aktiviert, 
wird ein Clip, der in der Clipliste selektiert wurde, 
in ihrer ursprünglichen Version auch innerhalb der 
Spur selektiert.

Selektieren des gesamten 
Materials über die 
Zeitbasis-Leisten

So selektieren Sie das gesamte Material auf allen 
angezeigten Audio- und MIDI-Spuren:

1 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Doppelklicken Sie auf eine beliebige Zeitbasis-
Leiste. Alle Clips auf allen angezeigten Audio- 
und MIDI-Spuren werden selektiert. 
Ausgeblendete Spuren werden nicht selektiert.

So selektieren Sie das gesamte Material auf allen 
Spuren, einschließlich der Conductor-Events:

1 Aktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Doppelklicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Wahltaste (Mac) auf eine 
beliebige Zeitbasis-Leiste. Alle Clips auf allen 
angezeigten Audio- und MIDI-Spuren werden 
selektiert, einschließlich aller Events auf den 
einzelnen Conductor-Spuren.

Selektieren während der 
Wiedergabe
In Pro Tools können Sie während der Wiedergabe 
mithilfe der Pfeiltasten nach oben oder unten 
Bereiche selektieren.

So nehmen Sie eine Selektion während der 
Wiedergabe vor:

1 Aktivieren Sie Options > Link Timeline and 
Edit Selection.

2 Klicken Sie mit dem Selector-Tool in der Nähe 
des Anfangs der Spur, auf der Sie die Selektion 
vornehmen möchten.

3 Klicken Sie im Transport-Fenster auf „Play“ 
(oder drücken Sie die Leertaste), um die 
Wiedergabe zu starten.

4 Wird die Stelle erreicht, an der Ihre Selektion 
beginnen soll, drücken Sie die Nach-unten-
Pfeiltaste.

5 Drücken Sie an der Position, an der Ihre 
Selektion enden soll, die Nach-oben-Pfeiltaste. 
Der selektierte Bereich wird markiert.

6 Um die Wiedergabe anzuhalten, klicken Sie im 
Transport-Fenster auf „Stop“ (oder drücken Sie 
die Leertaste).

Durch Drücken der Nach-links-Pfeiltaste gelangen 
Sie automatisch zum Beginn der Selektion (oder 
zu der Stelle auf dem Bildschirm, an der sich der 
Cursor befindet). Um zum Ende einer Selektion zu 
scrollen, drücken Sie die Nach-rechts-Pfeiltaste.

Der Page Scroll-Modus oder Continuous Scroll-
Modus wird vorübergehend deaktiviert, wenn Sie 
während der Wiedergabe in der Timeline oder 
einer Playlist eine Selektion vornehmen und sich 
der Playback-Cursor aus dem Bildschirmbereich 
bewegt. Klicken Sie in der Haupt-Zeitbasis-Leiste 
auf den Playback-Cursor-Locator, um in den Page 
Scroll-Modus zurückzukehren (siehe „Auffinden 
des Playback-Cursors außerhalb des 
Bildschirmbereichs“ auf Seite 408).
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Objektselektionen 
Verwenden Sie das Object Grabber-Tool, 
um nicht zusammenhängende Clips auf einer 
oder mehreren Spuren zu selektieren. Eine nicht 
zusammenhängende Selektion muss ganze Clips 
umfassen. Wenn Sie möchten, dass eine solche 
Selektion einen Teil eines Clips beinhaltet, müssen 
Sie daraus mit dem Separate Clip-Befehl zunächst 
einen neuen Clip erzeugen (siehe „Separate-
Befehle“ auf Seite 600).

So selektieren Sie nicht zusammenhängende Clips:

1 Legen Sie den Edit-Modus auf „Slip“ oder 
„Grid“ fest.

2 Klicken Sie im Grabber-Tools-Popup-Menü 
auf Object.

3 Klicken Sie bei gedrückter Umschalt-Taste auf 
jeden Clip, den Sie in die Selektion einschließen 
möchten. Die Clips können sich dabei auch auf 
verschiedenen Spuren befinden.

Eine dunkle Umrandung eines Clips zeigt an, dass 
er selektiert wurde.

Wenn Sie mit dem Object Grabber-Tool arbeiten, 
werden Edit-Gruppen beim Selektieren ignoriert. 
So werden etwa beim Selektieren eines Clips auf 
einer gruppierten Spur keine Clips auf anderen 
Spuren selektiert.

Umwandeln einer 
objektbasierten in eine 
zeitbasierte Selektion 
Sie können zwischen zeit- und objektbasierten 
Selektionen wechseln. Zeitbasierte Selektionen 
werden mit dem Selector- oder Time Grabber-
Tool, objektbasierte mit dem Object Grabber-Tool 
vorgenommen.

Konvertieren in eine objektbasierte Selektion 
ist sinnvoll, wenn Sie mit einer umfangreichen 
Selektion arbeiten, die sich über mehrere Spuren 
erstreckt, und einige Clips aus dieser Selektion 
entfernen möchten.

Die zeitbasierte Selektion ist dagegen sinnvoll, 
wenn Sie alle Clips innerhalb einer nicht 
zusammenhängenden objektbasierten Selektion 
auswählen möchten.

So wechseln Sie von der zeit- zur 
objektbasierten Selektion:

1 Ziehen Sie mit dem Selector-Tool auf eine 
Spur, um eine Selektion zu definieren, oder 
selektieren Sie in einer Zeitbasis-Leiste, 
um über alle Spuren hinweg zu selektieren.

2 Doppelklicken Sie mit dem Object Grabber-
Tool in der Symbolleiste auf das Grabber-
Symbol. Die Clips innerhalb der Selektion 
werden als Objekte markiert. Teilweise 
selektierte Clips werden deaktiviert.

Der Object Grabber ist nicht verfügbar, 
wenn der Edit-Modus auf „Shuffle“ oder 
„Spot“ eingestellt ist.

Object Grabber-Tool

Nicht zusammenhängende Selektion

Selektierte Clips

Als Objekte selektierte Clips
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Um Clips in die Selektion aufzunehmen, 
die teilweise ausgewählt wurden, doppelklicken 
Sie bei gedrückter Windows-Taste (Windows) 
bzw. Ctrl-Taste (Mac) auf das Grabber-Symbol.

So wechseln Sie von der objekt- zur 
zeitbasierten Selektion:

1 Selektieren Sie eine beliebige Anzahl an Clips 
mit dem Object Grabber-Tool.

2 Doppelklicken Sie in der Symbolleiste auf das 
Selector-Tool. Der Zeitbereich zwischen dem 
ersten und dem letzten Clip wird selektiert.

Beim Verwenden des Object Grabber-Tools auf 
Spuren, die zu einer Edit-Gruppe gehören, werden 
Clips in anderen gruppierten Spuren selektiert, 
wenn sie sich innerhalb des Bereichs des 
selektierten Clips befinden.

Ändern der Länge einer 
Selektion
Die Selektion kann verkürzt oder verlängert 
werden. Dies hat keine Auswirkungen auf das 
Material innerhalb der Selektion.

So ändern Sie die Länge einer Selektion:

 Positionieren Sie das Selector-Tool an einem 
der beiden Enden der aktuellen Selektion und 
klicken oder ziehen Sie bei gedrückter 
Umschalttaste nach links oder rechts.

 Verschieben Sie in der Haupt-Zeitbasis-Leiste 
den Marker für die Timeline-Selektion, der den 
Anfang oder das Ende der Selektion anzeigt.

 Wenn die Option Link Timeline and Edit 

Selection deaktiviert ist, können Sie die 
Länge der Selektion durch Ziehen des Edit-
Markers ändern.

So selektieren Sie einen längeren Bereich:

1 Klicken Sie mit dem Selector-Tool an der 
Position, an der die Selektion anfangen soll.

2 Scrollen Sie zum Endpunkt und klicken Sie 
bei gedrückter Umschalttaste auf den Punkt, 
an dem die Selektion enden soll. 

Sie können den Anfang und das Ende eines 
längeren Bereichs überprüfen, indem Sie die 
Nach-links-Pfeiltaste, um an den Anfang der 
Selektion, bzw. die Nach-rechts-Pfeiltaste 
drücken, um an deren Ende zu gelangen.

Verschieben von 
Selektionsbereichen mit 
der Nudge-Funktion
Selektionsbereiche (nicht das Spurmaterial 
innerhalb der Selektion) können um den Nudge-
Wert verschoben werden.

So verschieben Sie einen Selektionsbereich mit 
der Nudge-Funktion:

1 Konfigurieren Sie den Nudge-Wert. Weitere 
Hinweise finden Sie unter „Festlegen des 
Nudge-Werts“ auf Seite 607.

2 Nehmen Sie eine erste Selektion mit dem 
Selector-Tool vor.

3 Halten Sie die Umschalttaste gedrückt und 
drücken Sie die Plus-Taste (+) bzw. die Minus-
Taste (–) auf dem Ziffernblock, um die 
Selektion um den Nudge-Wert zu verschieben.

Ziehen eines Markers für die Timeline-Selektion

Edit-Marker



Pro Tools-Referenzhandbuch582

Verschieben des Start- und 
Endpunkts einer Selektion mit 
der Nudge-Funktion
Start- und Endpunkte von Selektionen können 
ebenfalls mithilfe der Nudge-Funktion 
verschoben werden.

So verschieben Sie den Start- oder Endpunkt einer 
Selektion um den Nudge-Wert:

1 Konfigurieren Sie den Nudge-Wert. Weitere 
Hinweise finden Sie unter „Festlegen des 
Nudge-Werts“ auf Seite 607.

2 Nehmen Sie eine erste Selektion mit dem 
Selector-Tool vor.

3 Sie haben folgende Möglichkeiten:

• Halten Sie Alt + Umschalt (Windows) bzw. 
Wahl + Umschalt (Mac) gedrückt und drücken 
Sie gleichzeitig die Plus-Taste (+) bzw. die 
Minus-Taste (–) auf dem Ziffernblock, um den 
Startpunkt der Selektion um den Nudge-Wert 
zu verschieben.

• Halten Sie Strg + Umschalt (Windows) bzw. 
Befehl + Umschalt (Mac) gedrückt und 
drücken Sie gleichzeitig die Plus-Taste (+) 
bzw. die Minus-Taste (–) auf dem Ziffernblock, 
um den Endpunkt der Selektion um den Nudge-
Wert zu verschieben.

Erweitern von Selektionen
Sie können Selektionen auf die Start- und 
Endposition eines Clips erweitern oder einen 
benachbarten Clip einschließen. Selektionen 
können auch auf Marker und Memory Locations 
erweitert werden.

So erweitern Sie eine Selektion bis zum Start- oder 
Endpunkt eines Clips:

1 Selektieren Sie mit dem Selector-Tool einen 
Bereich eines Clips oder klicken Sie an eine 
beliebige Stelle des Clips.

2 Sie haben folgende Möglichkeiten:

• Drücken Sie die Umschalttaste und die Tab-
Taste, um die Selektion bis zum Endpunkt des 
Clips zu erweitern.

• Drücken Sie Strg + Umschalt + Tab (Windows) 
bzw. Wahl + Umschalt + Tab (Mac), um die 
Selektion bis zum Startpunkt des Clips zu 
erweitern.

So erweitern Sie eine Selektion um eine 
angrenzende Region:

1 Selektieren Sie mit dem Time Grabber-Tool den 
ersten Clip.

2 Sie haben folgende Möglichkeiten:

• Drücken Sie bei deaktivierter Option „Tab to 
Transients“ Windows + Umschalt + Tab 
(Windows) bzw. Ctrl + Umschalt + Tab (Mac), 
um die Selektion bis zur nächsten Clipgrenze zu 
erweitern.

• Drücken Sie Strg + Windows + Umschalt + Tab 
(Windows) bzw. Wahl + Ctrl + Umschalt + Tab 
(Mac), um die Selektion bis zur vorhergehenden 
Clipgrenze zu erweitern.

So erweitern Sie eine Selektion bis zu einem 
Marker oder einer Memory Location:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie in einer Spur mit dem Selector-Tool 
auf den Start- oder Endpunkt.

• Nehmen Sie mit dem Selector- oder Time 
Grabber-Tool eine Selektion vor.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie bei gedrückter Umschalttaste auf 
einen Marker in der Markers-Leiste.

• Doppelklicken Sie im Memory Locations-
Fenster auf eine Memory Location.

Die Selektion wird vom ursprünglichen 
Einfügepunkt bis zum Marker bzw. zur Memory 
Location erweitert.
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Arbeiten mit den Edit-
Selektions-Anzeigen 
(Start, Ende und Länge)
Mithilfe der Edit-Selektions-Anzeigen oben 
im Edit-Fenster können Sie eine präzise Edit-
Selektion definieren. Die Zeitwerte für die Edit-
Selektions-Anzeigen werden durch die 
Zeitskala bestimmt.

So nehmen Sie eine Selektion über die Edit-
Selektions-Anzeigen vor:

1 Klicken Sie mit dem Selector-Tool auf die Spur, 
die Sie selektieren möchten.

2 Klicken Sie im Edit-Fenster oben auf das 
Start-Feld.

3 Geben Sie die Startposition Ihrer Selektion ein 
und drücken Sie die Taste „/“ (Schrägstrich), 
um den Wert zu bestätigen und automatisch 
zum End-Feld zu springen.

4 Geben Sie nun die Endposition ein und 
drücken Sie die Eingabetaste, um den Wert 
zu bestätigen.

Tastaturbefehle für die Zahleneingabe in die 
Selektionsanzeigen

Zur Eingabe von Zahlenwerten in die Edit-
Selektions-Anzeigen können Sie die folgenden 
Tastaturbefehle verwenden:

• Drücken Sie die Taste „/“ (Schrägstrich), 
um zwischen den drei Edit-Selektions-Anzeigen 
zu wechseln.

• Bewegen Sie sich mithilfe der Punkt-Taste (.) 
oder der Pfeiltasten nach links bzw. rechts 
durch die Eingabefelder einer jeden Edit-
Selektions-Anzeige.

• Verwenden Sie die Nach-oben- oder Nach-
unten-Pfeiltaste, um die Zahlenwerte zu erhöhen 
bzw. zu verringern.

• Bewegen Sie das Mausrad nach oben oder 
unten, um die Zahlenwerte zu erhöhen bzw. 
zu verringern.

• Ziehen Sie in einem Feld, um zu einem neuen 
Wert zu scrollen. Um detailliertere Anpassungen 
vorzunehmen, ziehen Sie bei gedrückter Strg-
Taste (Windows) bzw. Befehlstaste (Mac).

• Drücken Sie die Strg-Taste (Windows) bzw. 
die Befehlstaste (Mac) und die Plus- (+) oder 
Minus-Taste (–) und geben Sie dann eine Zahl 
ein, die zum aktuellen Feldwert addiert oder 
davon subtrahiert werden soll. Um 
beispielsweise den aktuellen Wert um 10 zu 
erhöhen, drücken Sie die Strg-Taste (Windows) 
bzw. die Befehlstaste (Mac) und die Plus-Taste 
(+), geben Sie die Zahl „10“ ein und drücken Sie 
die Eingabetaste.

• Drücken Sie die Esc-Taste, um die Edit-
Selektions-Anzeige ohne Eingabe eines 
Werts zu verlassen.

Berechnungsfunktion

Sie können die Edit-Selektions-Anzeigen 
rechnerisch bearbeiten.

So subtrahieren Sie Zeitwerte:

1 Markieren Sie in der Edit-Selektions-Anzeige 
das gewünschte Zeitfeld.

2 Drücken Sie die Minustaste (–) auf dem 
Ziffernblock.

3 Geben Sie die Zahl ein, die Sie vom aktuellen 
Zeitwert subtrahieren möchten, und drücken 
Sie die Eingabetaste.

4 Drücken Sie die Eingabetaste erneut, um die 
Änderung zu übernehmen.

Edit-Selektions-Anzeigen 

Diese Tastaturbefehle können auch zur 
Eingabe von Start- und Endwerten im 
Transport-Fenster verwendet werden.
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So addieren Sie Zeitwerte:

1 Markieren Sie in der Edit-Selektions-Anzeige 
das gewünschte Zeitfeld.

2 Drücken Sie die Plustaste (+) auf dem 
Ziffernblock.

3 Geben Sie die Zahl ein, die Sie zum aktuellen 
Zeitwert addieren möchten, und drücken Sie die 
Eingabetaste.

4 Drücken Sie die Eingabetaste erneut, um die 
Änderung zu übernehmen.

Selektieren über mehrere 
Spuren hinweg
Um in mehreren oder allen Spuren Editiervorgänge 
ausführen zu können, müssen Sie diese Spuren 
zunächst selektieren. Schließen Sie dazu andere 
Spuren in die Selektion ein oder selektieren Sie alle 
Spuren in einer Zeitbasis-Leiste.

So nehmen Sie eine Selektion auf mehreren 
Spuren vor:

 Ziehen Sie mit dem Selector-Tool vertikal, 
um angrenzende Spuren in die Selektion 
einzubeziehen. (Wenn Sie horizontal ziehen, 
definieren Sie den Zeitbereich.) 

So erweitern Sie eine Selektion um eine 
weitere Spur:

1 Nehmen Sie mithilfe des Selector- oder Time 
Grabber-Tools in der ersten Spur oder den 
ersten Spuren eine Selektion vor.

2 Klicken mit dem Selector-Tool bei gedrückter 
Umschalttaste auf weitere Spuren. Auf jeder 
weiteren Spur wird der gleiche Abschnitt 
selektiert wie auf der ersten.

Um die Selektion auf allen Spuren zu verkürzen 
bzw. zu verlängern, ziehen Sie bei gedrückter 
Umschalttaste.

So nehmen Sie eine Selektion über alle Spuren 
hinweg vor:

 Aktivieren Sie die Edit-Gruppe All und nehmen 
Sie auf einer beliebigen Spur eine Selektion vor.

 Ziehen Sie mit dem Selector-Tool in einer 
Zeitbasis-Leiste (stellen Sie sicher, dass 
Timeline- und Edit-Selektion gekoppelt sind).

Diese Selektionen enthalten alle Spuren im 
Edit-Fenster, nicht aber die Conductor-Spuren 
(für Tempo, Taktart und Marker).

So selektieren Sie über alle Spuren hinweg, 
inklusive der Conductor-Spuren (Tempo, Taktart 
und Marker):

 Ziehen Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) mit dem Selector-Tool in 
einer beliebigen Zeitbasis-Leiste.

Verschieben und Erweitern von 
Selektionen zwischen Spuren
Bei aktiviertem Befehls-Tastaturfokus ist das 
Verschieben und Erweitern von Edit-Selektionen 
auf angrenzende Spuren möglich.

So verschieben Sie eine Selektion auf eine 
angrenzende Spur:

1 Aktivieren Sie den Befehls-Tastaturfokus 
(siehe „Tastaturfokus“ auf Seite 27).

2 Nehmen Sie mit dem Selector- oder Time 
Grabber-Tool eine Selektion vor.

3 Sie haben folgende Möglichkeiten:

Befehls-Tastaturfokus-Schaltfläche aktiviert 
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• Drücken Sie die Buchstabentaste P auf Ihrer 
Tastatur, um die Selektion auf die vorangehende 
Spur zu verschieben.

• Drücken Sie die Semikolon-Taste (;), um die 
Selektion auf die nächste Spur zu verschieben.

In beiden Fällen wird die ursprüngliche Edit-
Selektion deaktiviert.

So erweitern Sie eine Selektion auf eine 
angrenzende Spur:

1 Aktivieren Sie den Befehls-Tastaturfokus 
(siehe „Tastaturfokus“ auf Seite 27).

2 Nehmen Sie mit dem Selector- oder Time 
Grabber-Tool eine Selektion vor.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie Umschalt + P, um die Selektion 
auf die vorangehende Spur zu erweitern.

• Drücken Sie Umschalt + Semikolon (;), um die 
Selektion auf die nächste Spur zu erweitern.

In beiden Fällen bleibt die ursprüngliche Edit-
Selektion weiterhin bestehen.

So entfernen Sie die unterste Spur aus 
einer Selektion:

 Drücken Sie Alt + Windows + Semikolon (;) 
(Windows) bzw. Wahl + Befehl + Semikolon (;) 
(Mac), um die unterste Spur zu entfernen.

Weitere nützliche 
Selektionstechniken
Selektionen können auch mit den folgenden 
Verfahren vorgenommen werden:

So positionieren Sie den Edit-Cursor genau am 
Start-, End- oder Sync-Punkt eines Clips:

1 Deaktivieren Sie die Tab to Transients-
Schaltfläche (Siehe „Springen zu 
Signalspitzen“ auf Seite 587.)

2 Klicken Sie mit dem Selector-Tool auf die Spur.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie die Tab-Taste, um den Cursor 
auf dem Start-, End- oder Sync-Punkt des 
nächsten Clips oder der nächsten Clipgruppe 
zu positionieren.

• Drücken Sie Strg + Tab (Windows) bzw. Wahl + 
Tab (Mac), um den Cursor auf dem Start-, End- 
oder Sync-Punkt des vorangehenden Clips oder 
der Clipgruppe zu platzieren.

So nehmen Sie eine Selektion mit dem 
Scrubber vor:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Aktivieren Sie die Option für Edit Insertion 
Follows Scrub/Shuttle und klicken Sie dann 
auf „OK“.

Drücken Sie bei deaktiviertem Befehls-
Tastaturfokus Windows + P (Windows) 
bzw. Ctrl + P (Mac), um die Selektion auf die 
vorangehende Spur zu verschieben, oder 
drücken Sie Windows + Semikolon (;) 
(Windows) bzw. Ctrl + Semikolon (;) (Mac), 
um die Selektion auf die nächste Spur 
zu verschieben.

Drücken Sie bei deaktiviertem Befehls-
Tastaturfokus Windows + Umschalt + P 
(Windows) bzw. Ctrl + Umschalt + P (Mac), 
um die Selektion auf die vorangehende Spur 
zu erweitern, oder drücken Sie Windows + 
Umschalt + Semikolon (;) (Windows) bzw. 
Ctrl + Umschalt + Semikolon (;) (Mac), 
um die Selektion auf die nächste Spur 
zu erweitern.
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3 Bewegen Sie den Scrubber über die Spur, 
um den passenden Startpunkt für Ihre Selektion 
zu finden, und lassen Sie die Maustaste an der 
gewünschten Position los.

4 Scrubben Sie bei gedrückter Umschalttaste zum 
gewünschten Endpunkt und lassen Sie die 
Maustaste los. Der Abschnitt zwischen dem 
Start- und Endpunkt ist nun selektiert.

So verschieben Sie eine Selektion in einen 
angrenzenden Clip auf derselben Spur:

1 Selektieren Sie mit dem Time Grabber-Tool 
einen Clip.

2 Sie haben folgende Möglichkeiten:

• Drücken Sie Windows + Tab (Windows) bzw. 
Ctrl + Tab (Mac), um die Selektion in den 
nächsten Clip zu verschieben. 

• Drücken Sie Strg + Windows + Tab (Windows) 
bzw. Wahl + Ctrl + Tab (Mac), um die Selektion 
in den vorangehenden Clip zu verschieben.

In allen Fällen wird der ursprüngliche 
Clip deaktiviert.

So verschieben Sie eine Edit-Selektion in der 
Haupt-Zeitbasis-Leiste:

1 Nehmen Sie mit dem Selector- oder Time 
Grabber-Tool eine Selektion vor.

2 Bewegen Sie den Cursor bei gedrückter Alt-
Taste (Windows) bzw. Wahltaste (Mac) über 
einen der Marker für die Timeline-Selektion in 
der Leiste (der Time Grabber wird angezeigt).

3 Ziehen Sie nach links oder rechts, um die Edit-
Selektion auf der Zeitachse zu verschieben und 
dabei ihre Länge beizubehalten.

Wenn „Link Timeline and Edit Selection“ 
deaktiviert ist (Options > Link Timeline and Edit 

Selection), ziehen Sie stattdessen bei gedrückter 
Alt-Taste (Windows) bzw. Wahltaste (Mac) die 
Edit-Marker.

Rechtsklick-Befehle und Erhalt 
der Selektion
Sie können die Rechtsklick-Befehle zusammen 
mit Tastenkombinationen verwenden, 
um Vorgänge mit Objekten auszuführen, und 
dabei gleichzeitig die Selektionen in den Edit- und 
Mix-Fenstern beibehalten. Beispielsweise können 
Sie die Selektionen in den folgenden Bereichen 
beibehalten, während Sie gleichzeitig bestimmte 
Befehle ausführen:

• Clip-Selektionen in der Timeline

• Auswahl von Clipnamen in der Clipliste

• Spurselektionen

So wenden Sie einen Befehl auf ein Objekt an und 
behalten dabei die aktuelle Selektion bei:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) mit der 
rechten Maustaste auf das Objekt und wählen 
Sie einen Befehl aus dem Popup-Menü aus.

Verschieben einer Edit-Selektion in der Haupt-
Zeitbasis-Leiste
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Springen zu Signalspitzen
Wenn die Tab to Transients-Schaltfläche aktiviert 
ist, können Sie in der Waveform-Darstellung in 
Audiowellenformen automatisch zu Signalspitzen 
navigieren, indem Sie den Cursor kurz vor den 
Beginn eines Spitzenwerts platzieren. Auf diese 
Weise können Sie Selektionen und 
Wiedergabebereiche sowie Start- und Endpunkte 
für neue Clips definieren, ohne die Wellenform 
vergrößern zu müssen. 

In der Warp-Darstellung springen Sie mit „Tab to 
Transients“ zu allen Event- und Warp-Markern 
in einem Clip. Mit der normalen Tab-Funktion 
springen Sie zu Clipgrenzen und allen Warp-
Markern. Wenn Sie in der Analysis-Darstellung 
die Tab-Taste drücken, springen Sie zu Event-
Markern, dabei spielt es keine Rolle, ob „Tab to 
Transients“ aktiviert ist.

Wenn Sie bei MIDI- und Instrumentenspuren 
in der Notendarstellung die Tab-Taste drücken, 
springen Sie zur nächsten Note, dabei spielt es 
keine Rolle, ob „Tab to Transients“ aktiviert ist. 
In der Clip-Darstellung springen Sie mit „Tab to 
Transients“ zu Noten und mit der normalen Tab-
Funktion zu Clipgrenzen. 

Wenn Sie bei MIDI-Noten zu Akkorden springen, 
wird jede Note im Akkord als ein Event angesehen. 
So können Sie zu jeder Note im Akkord springen.

Wenn „Tab to Transients“ aktiviert ist, wird der 
Cursor mit der Tab-Funktion an die Start- und 
Endpunkte eines Clips aber nicht an den Sync-
Punkten platziert.

So definieren Sie den Start- oder Endpunkt einer 
Selektion mit der Tab to Transients-Option:

1 Klicken Sie oben links im Edit-Fenster auf die 
Tab to Transients-Schaltfläche, sodass diese 
aktiviert wird.

2 Wenn Sie mit dieser Selektion den 
Wiedergabebereich definieren, aktivieren Sie 
Options > Link Timeline and Edit Selection.

3 Klicken Sie auf die Audiospur kurz vor das 
Material, das Sie selektieren möchten.

4 Drücken Sie die Tab-Taste mehrmals, bis sich 
der Cursor an der Signalspitze befindet, an der 
die Selektion beginnen soll.

Gegebenenfalls können Sie auch zur vorangehenden 
Signalspitze zurückkehren, indem Sie Strg + Tab 
(Windows) bzw. Wahl + Tab (Mac) drücken.

5 Drücken Sie Umschalt + Tab, bis der Cursor am 
Ende des gewünschten Materials positioniert ist.

Um den Endpunkt einer Selektion auf die 
vorangehende Signalspitze zu bewegen, drücken 
Sie Strg + Umschalt + Tab (Windows) bzw. 
Wahl + Umschalt + Tab (Mac).

Sobald es selektiert ist, kann das Material für die 
Aufnahme und die Wiedergabe geloopt werden 
oder es kann mit dem Separate- oder Capture-
Befehl ein neuer Clip daraus erstellt werden.

„Tab to Transients“ für mehrere Spuren

Wenn mit dem Edit-Cursor mehrere Spuren 
eingefügt wurden, können Sie mit „Tab to 
Transients“ zur nächsten Signalspitze auf einer 
dieser Spuren springen. Wenn die Signalspitzen 
auf mehreren Spuren eng abgestimmt sind, 
springen Sie mit „Tab to Transients“ zur ersten 
Signalspitze auf einer dieser Spuren.

Tab to Transients-Schaltfläche aktiviert 

Um „Tab to Transients“ ein- und auszuschalten, 
drücken Sie Strg + Alt + Tab (Windows) bzw. 
Befehl + Wahl + Tab (Mac).

Signalspitzen sind normalerweise in der 
Wellenformanzeige sichtbar. Bei besonders 
niedrigen Frequenzen sind sie manchmal im 
Wellenformat nicht zu erkennen.
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Timeline-Selektionen
Bei deaktivierter Option „Link Timeline an Edit 
Selection“ können Sie in der Timeline Selektionen 
vornehmen, die sich von den Edit-Selektionen 
unterscheiden.

Bei einer Kopplung von Timeline- und Edit-
Selektionen wird jede Edit-Selektion in der 
Timeline gespiegelt und jede Timeline-
Selektion wird als Edit-Selektion über alle 
Spuren gespiegelt.

Unabhängig davon, ob Timeline- und Edit-
Selektion gekoppelt sind, wird mit dem von den 
Markern für die Timeline-Selektion angegebenen 
Bereich immer der Bereich für die Wiedergabe 
und die Aufnahme bestimmt (außer im Dynamic 
Transport-Modus, siehe „Dynamic Transport-
Modus“ auf Seite 419).

Wenn in Pro Tools HD die Scrolling-Option auf 
„Center Playhead“ festgelegt ist, wird damit der 
Anfang der Wiedergabe bestimmt (siehe 
„Wiedergeben von Timeline- und Edit-
Selektionen mit dem Playhead“ auf Seite 417).

So nehmen Sie eine Timeline-Selektion über das 
Selector-Tool vor:

1 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

2 Ziehen Sie mit dem Selector-Tool in einer 
beliebigen Zeitbasis-Leiste.

Die Timeline-Selektion wird auf der Haupt-
Zeitbasis-Leiste durch blaue Marker für 
die Timeline-Selektion angegeben 
(bei scharfgeschalteten Spuren sind die Marker für 
die Timeline-Selektion rot). Der Beginn, das Ende 
und die Länge der Timeline-Selektion werden 
in den entsprechenden Feldern im Transport-
Fenster angezeigt.

So legen Sie die Timeline-Selektion durch Ziehen 
der Marker für die Timeline-Selektion fest:

1 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Bewegung durch das aktuell 
eingestellte Raster zu begrenzen. 

2 Verschieben Sie mit dem Time Grabber 
den ersten Marker für die Timeline-
Selektion (Pfeil nach unten), um den 
Startpunkt einzustellen.

3 Verschieben Sie den anderen Marker für die 
Timeline-Selektion (Pfeil nach oben), um den 
Endpunkt einzustellen.

Timeline-Selektion mit dem Selector-Tool

Um alle Spuren, inklusive der Dirigenten-
Spuren, zu selektieren, halten Sie die Alt-
Taste (Windows) bzw. die Wahltaste (Mac) 
gedrückt und ziehen mit dem Selector-Tool 
in eine Zeitbasis-Leiste.

Ziehen eines Markers für die Timeline-Selektion
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So legen Sie die Timeline-Selektion durch Eingabe 
im Transport-Fenster fest:

1 Ändern Sie bei Bedarf das Transport-Fenster 
zur erweiterten Darstellung, damit die Start- 
und Endzeiten angezeigt werden (View > 
Transport > Expanded).

2 Sie haben folgende Möglichkeiten:

• Klicken Sie im Transport-Fenster in das 
Start-Feld.

• Drücken Sie Alt + Schrägstrich (/) (Windows) 
bzw. Wahl + Schrägstrich (/) (Mac) auf dem 
Ziffernblock, um das Start-Feld im Transport-
Fenster auszuwählen.

3 Geben Sie die neue Startposition ein und 
drücken Sie die Taste „/“ (Schrägstrich), um den 
Wert zu bestätigen und automatisch zum End-
Feld zu springen.

4 Geben Sie nun die neue Endposition ein und 
drücken Sie die Eingabetaste, um den Wert 
zu bestätigen.

Verschieben einer Timeline-
Selektion
Ebenso wie Edit-Selektionen können auch 
Timeline-Selektionen in der Haupt-Zeitbasis-
Leiste verschoben werden.

So verschieben Sie eine Timeline-Selektion in 
der Haupt-Zeitbasis-Leiste:

1 Bewegen Sie den Cursor bei gedrückter Alt-
Taste (Windows) bzw. Wahltaste (Mac) über 
einen der Marker für die Timeline-Selektion 
(der Time Grabber wird angezeigt).

2 Ziehen Sie nach links oder rechts, um die 
Timeline-Selektion zeitlich nach vorn oder 
hinten zu verschieben, während die Länge 
beibehalten wird.

Kopieren von Edit- und Timeline-
Selektionen
Wenn Timeline- und Edit-Selektionen nicht 
miteinander gekoppelt sind, können Sie Edit-
Selektionen in Timeline-Selektionen kopieren 
und umgekehrt.

So ändern Sie die Timeline-Selektion 
entsprechend der aktuellen Edit-Selektion:

 Wählen Sie Edit > Selection > Change Timeline 
to Match Edit.

So ändern Sie die Edit-Selektion entsprechend der 
aktuellen Timeline-Selektion:

 Wählen Sie Edit > Selection > Change Edit to 
Match Timeline.

Navigieren in der Timeline mit 
den Zählern und Anzeigen im 
Edit-Fenster
Die Zähler und Anzeigen oben im Edit-Fenster 
zeigen die aktuelle Wiedergabeposition und die 
Edit-Selektion an. Dazu gehören Hauptzähler und 
Nebenzähler (Main und Sub Counter) sowie die 
Anzeigen für das Editieren von Selektions-Start, -
Ende und -Länge.

Bei allen Zählern und Anzeigen im Edit-Fenster 
(außer dem Nebenzähler) können Sie einen Wert 
eingeben, um eine bestimmte zeitliche Position 
anzusteuern.

Tastenkombinationen zur Eingabe von Start- 
und Endwerten im Transport-Fenster sind 
unter „Tastaturbefehle für die Zahleneingabe 
in die Selektionsanzeigen“ auf Seite 583 
aufgelistet.

Drücken Sie Alt + Umschalt + 5 (Windows) 
bzw. Wahl + Umschalt + 5 (Mac), um die 
Timeline-Selektion entsprechend der Edit-
Selektion zu ändern.

Drücken Sie Alt + Umschalt + 6 (Windows) 
bzw. Wahl + Umschalt + 6 (Mac), um die 
Edit-Selektion entsprechend der Timeline-
Selektion zu ändern.

Hauptzähler und Nebenzähler (Main und Sub), Edit-
Selektions-Anzeigen
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Der Hauptzähler zeigt die aktuelle 
Wiedergabeposition im gleichen Zeitformat wie 
die Zeitskala an. Der Nebenzähler kann auf ein 
beliebiges anderes Zeitformat eingestellt werden.

Die Edit-Selektions-Anzeigen (rechts neben 
Haupt- und Nebenzähler) zeigen die Start- und 
Endzeiten sowie die Länge der aktuellen Edit-
Selektion gemäß der Zeitskala an.

Haupt- und Nebenzähler sowie die Edit-
Selektions-Anzeigen werden auch im Transport-
Fenster angezeigt, wenn dafür die Anzeige von 
Zählern aktiviert ist.

So navigieren Sie im Edit-Fenster mit dem 
Hauptzähler oder einer der Edit-Selektions-
Anzeigen:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf einen der beiden Zähler.

• Drücken Sie die Sternchentaste (*) auf dem 
Ziffernblock, um den Hauptzähler im Edit-
Fenster (oder den Hauptzähler im Transport-
Fenster bzw. dem Big Counter-Fenster, wenn 
diese angezeigt werden) zu markieren.

2 Geben Sie die neue Position ein. Um von einem 
Zeitfeld ins nächste zu gelangen, drücken Sie 
die Punkt-Taste (.).

3 Durch Drücken der Eingabetaste wird der neue 
Wert akzeptiert und Sie gelangen automatisch 
an die neue Position.

Scrollen in einer Zeitbasis-Leiste
Sie können durch das Edit-Fenster scrollen, indem 
Sie auf eine Leiste klicken und ziehen. Hierdurch 
lässt sich zwar nicht die aktuelle Position der 
Session ändern, die Darstellung im Display kann 
jedoch bequem nach links oder rechts verschoben 
werden. So können Sie bestimmtes Material 
bequem finden und editieren.

Diese Vorgehensweise ist besonders dann 
sinnvoll, wenn die Option „Continuous Scrolling“ 
(nur in Pro Tools HD) aktiviert ist, die Timeline-
Selektionen weder aktualisiert noch ihnen folgt.

So scrollen Sie den gesamten Inhalt des Edit-
Fensters mithilfe einer Leiste:

 Halten Sie Strg + Alt + Windows (Windows) 
bzw. Befehl + Wahl + Ctrl (Mac) gedrückt und 
ziehen Sie in einer beliebigen Zeitbasis-Leiste 
nach links oder rechts.

Scrollen mit dem Mausrad
Wenn Sie eine Radmaus verwenden, können Sie 
in jedem Pro Tools-Fenster mit Bildlaufleiste 
(etwa in der MIDI Event-Liste) mithilfe des 
Rads vertikal und horizontal scrollen.

So scrollen Sie in einem Pro Tools-
Fenster vertikal:

1 Platzieren Sie die Maus in dem Fenster, in dem 
Sie scrollen möchten. Im Edit-Fenster können 
Sie etwa in der Spurenanzeige oder der 
Clipliste scrollen.

2 Drehen Sie das Mausrad nach oben oder unten, 
um im Fenster auf und ab zu scrollen.

So scrollen Sie in einem Pro Tools-
Fenster horizontal:

1 Platzieren Sie die Maus in dem Fenster, 
in dem Sie scrollen möchten. Im Edit-Fenster 
können Sie etwa in der Spurenanzeige oder 
der Clipliste scrollen.

2 Drehen Sie das Mausrad bei gedrückter 
Umschalttaste nach oben oder unten, um im 
Fenster nach links oder rechts zu scrollen.

Scrollen in einer Leiste
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Automatisches Scrollen 
von Spuren im Edit- und 
im Mix-Fenster
Wenn Sie mit mehr Spuren arbeiten, als im Edit- 
oder Mix-Fenster gleichzeitig angezeigt werden 
können, können Sie in einem Fenster eine Spur 
auswählen und Pro Tools scrollt in beiden 
Fenstern automatisch zu dieser Spur.

Führen Sie einen der folgenden Schritte aus, 
um automatisch in Mix- und Edit-Fenster zu 
scrollen, sodass eine Spur angezeigt wird:

 Klicken Sie in der Tracks-Liste mit der rechten 
Maustaste auf den Spurnamen und wählen Sie 
Scroll into View.

 Klicken Sie in der Tracks-Liste bei gedrückter 
Ctrl-Taste (Mac) auf den Spurnamen und 
wählen Sie Scroll into View.

Die Spur wird ausgewählt und Mix- und Edit-
Fenster scrollen automatisch an die geeignete 
Stelle, um die ausgewählte Spur anzuzeigen.

Mithilfe von Spur-
Positionsnummern zu 
Spuren navigieren
Bei aktivierter Spurnummerndarstellung wird 
jeder Spur entsprechend ihrer Position im Mix- 
und Edit-Fenster eine Nummer zugewiesen. Sie 
können über die Positionsnummer direkt zu jeder 
beliebigen Spur gelangen.

So navigieren Sie mithilfe der Spur-
Positionsnummern direkt zu einer Spur:

1 Wählen Sie View > Track Number.

2 Wählen Sie Track > Scroll to Track.

3 Geben Sie im Dialogfeld „Scroll To Track“ 
die Spurnummer der Spur ein, die Sie 
anzeigen möchten.

4 Klicken Sie auf OK.

Die Spur wird ausgewählt und die Fensteranzeige 
ändert sich wie folgt:

• Die Spuren im Edit-Fenster werden so 
verschoben, dass die ausgewählte Spur so 
weit oben wie möglich angezeigt wird. 

• Die Spuren im Mix-Fenster werden so 
verschoben, dass die ausgewählte Spur so 
weit links wie möglich angezeigt wird. 

Wenn Spuren neu sortiert werden, werden die 
Spur-Positionsnummern neu zugewiesen, 
damit die Nummern weiterhin logisch 
aufeinander folgen.

Drücken Sie Strg + Alt + F 
(Windows) bzw. Befehl + Wahl + F 
(Mac), um zur Spur zu scrollen.

Scroll To Track-Dialogfeld
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Universe-Darstellung
In der Universe-Darstellung wird im Edit-Fenster oberhalb des Spurenfensterbereichs eine Übersicht der 
gesamten Pro Tools-Session angezeigt. 

Diese Übersicht zeigt das Audio- und MIDI-
Material in allen Spuren in der Session, das nicht 
ausgeblendet ist (einschließlich inaktiver Spuren 
oder Spuren mit Offline-Clips). Die Reihenfolge, 
in der das Material in der Universe-Darstellung 
angezeigt wird, entspricht der Reihenfolge der 
Spuren im Edit-Fenster.

In der Universe-Ansicht sind Audio-, MIDI- und 
Video-Clips auf Spuren durch horizontale Linien 
in denselben Farben wie die Bereiche auf den 
Spuren dargestellt. Jede Audiospur wird 
unabhängig von der Anzahl der Kanäle in der 

gleichen Höhe dargestellt. Außerdem werden 
Spuren mit Automations-, Controller- oder 
Playlist-Lanes für jede angezeigte Spur mit 
zunehmender Höhe dargestellt.

Da Aux-Eingangs-, Master-Fader- und VCA 
Master-Spuren keine Audio- oder MIDI-Clips 
enthalten, werden sie in der Universe-Darstellung 
als leere Bereiche angezeigt.

Universe-Darstellung oben im Edit-Fenster
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Anzeigen des Universe-Fensters

Führen Sie einen der folgenden Schritte aus, 
um die Universe-Darstellung im Edit-Fenster ein- 
oder auszublenden:

 Aktivieren oder deaktivieren Sie View > Other 

Displays > Universe.

 Doppelklicken Sie auf die Trennlinie oberhalb 
der Haupt-Zeitbasis-Leiste. 

 Aktivieren oder deaktivieren Sie im Popup-
Menü des Edit-Fensters die Option Universe.

 Klicken Sie auf die Schaltfläche „Show/Hide 
Universe view“.

Umrahmter Bereich in der 
Universe-Darstellung
Der umrahmte Bereich in der Universe-
Darstellung stellt das dar, was im 
Spurenfensterbereich des Edit-Fensters sichtbar 
ist. Wenn Sie die Anzeige im Edit-Fenster ändern, 
etwa durch Zoomen, horizontales oder vertikales 
Scrollen, Einblenden bzw. Ausblenden von 
Spuren oder Verändern der Spurhöhe, werden 
Position und Größe des umrahmten Bereichs in 
der Universe-Darstellung entsprechend geändert. 
Ist im Edit-Fenster während der Wiedergabe 
die Option zum Scrollen aktiviert, wird der 
umrahmte Bereich in der Universe-Darstellung 
ebenfalls gescrollt.

Wenn alle Spuren im Edit-Fenster sichtbar sind 
und die Session den gesamten Bildschirm ausfüllt, 
wobei alle Clips sichtbar sind, wird das gesamte 
Universe-Fenster umrahmt.

Aktivieren der Universe-Darstellung im Popup-Menü 
des Edit-Fensters

Klicken auf die Schaltfläche „Show/Hide Universe 
view“

Umrahmter Bereich mit Darstellung des Teils der 
Session, der im Spurenfensterbereich des Edit-
Fensters angezeigt wird
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Navigieren in der Universe-
Darstellung
Durch Klicken in die Universe-Darstellung 
können Sie das im Edit-Fenster dargestellte 
Material horizontal, vertikal oder in beide 
Richtungen scrollen. So kann das Edit-
Fenster bequem an beliebiger Stelle in der 
Session fokussiert werden.

So navigieren Sie mithilfe der Universe-
Darstellung in der Session:

1 Stellen Sie sicher, dass die Universe-
Darstellung angezeigt wird (View > Other 

Displays > Universe).

2 Klicken Sie auf eine beliebige Stelle in der 
Universe-Darstellung, um den umrahmten 
Bereich zu verschieben; das Edit-Fenster 
wird entsprechend aktualisiert.

Ändern der Größe der Universe-
Darstellung
Sie können die Höhe der Universe-Darstellung 
ändern, um sie an die Gesamtanzahl der Spuren in 
der Session anzupassen oder mehr vom Edit-
Fenster anzuzeigen.

So ändern Sie die Höhe der Universe-Darstellung:

1 Klicken Sie zwischen dem unteren Rand des 
Universe-Fensters und dem oberen Rand der 
Zeitbasis-Leiste. Die Cursor-Darstellung ändert 
sich und zeigt an, dass Sie die Größe der 
Universe-Darstellung verändern können.

2 Ziehen Sie nach oben, um die Höhe der 
Universe-Darstellung zu verringern, oder 
ziehen Sie nach unten, um die Höhe der 
Universe-Darstellung zu vergrößern.

Scrollen in der Universe-
Darstellung
Wenn mehr Spuren in der Session vorhanden sind 
als in der Universe-Darstellung sichtbar, können 
Sie die anderen Spuren durch Scrollen nach unten 
oder oben anzeigen.

So scrollen Sie in der Universe-Darstellung nach 
oben oder unten:

 Klicken Sie auf der rechten Seite der Universe-
Darstellung auf die Aufwärts-/Abwärts-
Bildlaufpfeile.

Ändern der Größe der Universe-Darstellung

Aufwärts-/Abwärts-Bildlaufpfeile in der Universe-
Darstellung



Kapitel 26: Auswählen einer Selektion 595

Navigieren in einer Pro Tools-
Session
Sie können in Pro Tools nicht nur mit der 
Universe-Darstellung schnell und einfach 
durch die Session navigieren, sondern auch mit 
Tastenkombinationen. In diesem Abschnitt 
erhalten Sie einen Überblick über die wichtigsten 
Tastaturbefehle, mit denen Sie in der Session 
navigieren und eine Edit-Selektion 
vornehmen können.

Heranzoomen der gesamten 
Session und der Edit-Selektion

So zoomen Sie die gesamte Session in die 
Darstellung:

1 Drücken Sie Alt + Windows + A (Windows) 
bzw. Wahl + Ctrl + A (Mac), um den Anfang 
und das Ende der Session horizontal an die 
Länge des Edit-Fensters anzupassen.

2 Drücken Sie Alt + Windows + Pfeil nach oben 
(Windows) bzw. Wahl + Ctrl + Pfeil nach oben 
(Mac), um alle Spuren in der Session an die 
Höhe des Edit-Fensters anzupassen.

So zoomen Sie eine Edit-Selektion heran:

1 Nehmen Sie mit dem Selector- oder Grabber-
Tool eine Edit-Selektion vor.

2 Drücken Sie Alt + Windows (Windows) bzw. 
Wahl + Ctrl + F (Mac), um die Länge der 
Selektion an die Länge des Edit-Fensters 
anzupassen.

3 Drücken Sie Strg + Windows + Pfeil nach oben 
(Windows) bzw. Befehl + Ctrl + Pfeil nach 
oben (Mac), um die Darstellungshöhe der 
Spuren in der Edit-Selektion an die Höhe des 
Edit-Fensters anzupassen.

So zoomen Sie die Edit-Selektion mit der Zoom 
Toggle-Funktion:

1 Nehmen Sie mit dem Selector- oder Grabber-
Tool eine Edit-Selektion vor.

2 Drücken Sie Windows + E (Windows) bzw. 
Ctrl + E (Mac), um die Zoom Toggle-Funktion 
zu aktivieren.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie Windows + E (Windows) bzw. 
Ctrl + E (Mac) erneut, um wieder den 
Zoomstatus der Vorschau anzuzeigen.

• Drücken Sie Alt + Umschalt + E (Windows) 
bzw. Wahl + Umschalt + E (Mac), um die Zoom 
Toggle-Funktion abzubrechen, ohne zur 
vorherigen Darstellung zurückzukehren.

Erstellen einer Edit-Selektion 
mit „Tab to Transients“
Bei der Bearbeitung von Audiomaterial mit klaren 
Signalspitzen können Sie mit „Tab to Transients“ 
eine Edit-Selektion vornehmen: 

So schalten Sie „Tab to Transients“ ein oder aus:

 Drücken Sie Strg + Alt + Tab (Windows) bzw. 
Befehl + Wahl + Tab (Mac).

So navigieren Sie und erweitern Sie Selektionen 
vorwärts mit „Tab to Transients“:

1 Platzieren Sie bei ausgewähltem Selector-Tool 
den Edit-Cursor vor der ersten Signalspitze, 
die in der Selektion enthalten sein soll.

2 Drücken Sie die Tab-Taste, um den Edit-Cursor 
auf der ersten Signalspitze zu platzieren.

Drücken Sie F7 für das Selector-Tool oder 
F8 für das Grabber-Tool.

Drücken Sie F7 für das Selector-Tool oder 
F8 für das Grabber-Tool.

Legen Sie in den Editing-Voreinstellungen 
die Option „Track Height“ für „Zoom 
Toggle“ auf „Fit To Window“ fest.
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3 Drücken Sie Umschalt + Tab, um die Selektion 
bis zur nächsten Signalspitze zu erweitern.

So navigieren Sie und erweitern Sie Selektionen 
rückwärts mit „Tab to Transients“:

• Drücken Sie Strg + Tab (Windows) bzw. Wahl + 
Tab (Mac), um den Edit-Cursor auf die 
vorangehende Signalspitze zu verschieben.

• Drücken Sie Strg + Umschalt + Tab (Windows) 
bzw. Wahl + Umschalt + Tab (Mac), um die 
Selektion auf die vorangehende Signalspitze 
zu erweitern.

Vornehmen einer Edit-Selektion 
während der Wiedergabe

So nehmen Sie eine Edit-Selektion während der 
Wiedergabe vor:

1 Platzieren Sie den Edit-Cursor auf der Spur 
oder auf mehreren Spuren für Ihre Selektion.

2 Starten Sie die Wiedergabe.

3 Drücken Sie die Nach-unten-Pfeiltaste, 
um den Edit-Cursor an der aktuellen 
Wiedergabeposition zu platzieren und den 
Anfang der Edit-Selektion zu markieren.

4 Drücken Sie die Nach-oben-Pfeiltaste, um den 
Endpunkt der Edit-Selektion zu markieren.

5 Halten Sie die Wiedergabe an.

6 Sie haben folgende Möglichkeiten:

• Drücken Sie die Nach-links-Pfeiltaste, um den 
Anfang der Edit-Selektion zu suchen.

• Drücken Sie die Nach-rechts-Pfeiltaste, um das 
Ende der Edit-Selektion zu suchen.

Ändern der Edit-Selektion
Pro Tools bietet mehrere Tastenkombinationen 
zum Verschieben und Erweitern oder Verkleinern 
des Bereichs einer Edit(oder Timeline)-Selektion.

So verschieben Sie die Selektion nach unten auf 
die nächste Spur:

 Drücken Sie Windows +; (Semikolon) 
(Windows) bzw. Ctrl +; (Semikolon) (Mac).

So verschieben Sie die Selektion nach oben auf 
die nächste Spur:

 Drücken Sie Windows + P (Windows) bzw. 
Ctrl + P (Mac).

So verschieben Sie die Selektion um das 
Selektionsmaß nach vorn:

 Drücken Sie Strg + Alt + Windows + ' 
(einfaches Anführungszeichen) (Windows) 
bzw. Befehl + Wahl + Ctrl + ' (einfaches 
Anführungszeichen) (Mac).

So verschieben Sie die Selektion um das 
Selektionsmaß zurück:

 Drücken Sie Strg + Alt + Windows + L 
(Windows) bzw. Befehl + Wahl + Ctrl + L (Mac).

So verdoppeln Sie die Edit-Selektion:

 Drücken Sie Strg + Alt + Windows + 
Umschalt + ' (einfaches Anführungszeichen) 
(Windows) bzw. Befehl + Wahl + Ctrl + 
Umschalt + ' (einfaches Anführungszeichen) 
(Mac).

Um die Edit-Selektion mehrere Spuren nach 
unten zu erweitern, drücken Sie Windows + 
Umschalt +; (Semikolon) (Windows) bzw. 
Ctrl + Umschalt +; (Semikolon) (Mac).

Um die Edit-Selektion mehrere Spuren nach 
oben zu erweitern, drücken Sie Windows + 
Umschalt + P (Windows) bzw. Ctrl + 
Umschalt + P (Mac).
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So halbieren Sie die Edit-Selektion:

 Drücken Sie Strg + Alt + Windows + 
Umschalt + L (Windows) bzw. Befehl + Wahl + 
Ctrl + Umschalt + L (Mac).

Verschieben des Einfügepunkts 
an den Anfang oder das Ende 
der Selektion
Bei angehaltenem Transport können Sie die 
Pfeiltasten nach unten und nach oben auf der 
Tastatur verwenden, um den Einfügepunkt am 
Anfang oder Ende der Edit-Selektion 
(oder Timeline-Selektion) zu platzieren 
(und die Selektion zu reduzieren).

So verschieben Sie den Einfügepunkt an den 
Anfang der Selektion:

 Drücken Sie die Nach-unten-Pfeiltaste.

So verschieben Sie den Einfügepunkt an das Ende 
der Selektion:

 Drücken Sie die Nach-oben-Pfeiltaste.

Wiederherstellen der 
letzten Selektion
Manchmal geht die Selektion beim Editieren 
verloren. Wenn die aktuelle Edit-Selektion 
(oder Timeline-Selektion) verloren geht und Sie 
sie wiederherstellen möchten, verwenden Sie den 
Befehl Restore Last Selection. 

So stellen Sie die letzte Selektion wieder her:

 Wählen Sie Edit > Restore Last Selection.

Ändern der Darstellungshöhe 
von Spuren

So passen Sie die Darstellungshöhe von Spuren 
mit der Edit-Selektion an die Höhe des Edit-
Fensters an:

 Drücken Sie Strg + Windows + Pfeil nach oben 
(Windows) bzw. Befehl + Ctrl + Pfeil nach 
oben (Mac).

So ändern Sie die Spurhöhe mit der Edit-Selektion 
proportional:

 Drücken Sie Windows + Pfeil nach oben oder 
unten (Windows) bzw. Ctrl + Pfeil nach oben 
oder unten (Mac).

So ändern Sie die Spurdarstellung gleichzeitig für 
alle Spuren:

 Drücken Sie Alt + Windows + Pfeil nach oben 
oder unten (Windows) bzw. Wahl + Ctrl + Pfeil 
nach oben oder unten (Mac).

Ändern der Spurdarstellung

So ändern Sie die Spurdarstellung von Spuren mit 
der Edit-Selektion:

 Drücken Sie Strg + Windows + Pfeil nach links 
oder rechts (Windows) bzw. Befehl + Ctrl + 
Pfeil nach links oder rechts (Mac).

So ändern Sie die Spurdarstellung gleichzeitig für 
alle Spuren:

 Drücken Sie Strg + Alt + Windows + Pfeil nach 
links oder rechts (Windows) bzw. Befehl + 
Wahl + Ctrl + Pfeil nach links oder rechts (Mac).

Sie können auch Strg + Alt + Z (Windows) 
bzw. Befehl + Wahl + Z (Mac) drücken, um die 
vorherige Selektion wiederherzustellen.
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Kapitel 27: Editieren von Clips und 
Selektionen

Clips sind die Grundbausteine für das Anordnen 
von Audio- und MIDI-Material in Pro Tools. 
Um die Editiermöglichkeiten von Pro Tools in 
vollem Umfang nutzen zu können, sollten Sie sich 
unbedingt mit dem Erstellen, Editieren und 
Anordnen von Clips vertraut machen.

In diesem Kapitel werden grundlegende 
Editierfunktionen für Clips und Clipgruppen 
sowie Selektionen behandelt, die zum größten 
Teil sowohl für MIDI- als auch Audiodaten gelten. 

Spezielle Informationen zum Editieren von MIDI-
Material finden Sie unter Kapitel 31: „Editieren 
von MIDI-Daten“. Die Editierverfahren für 
Videos finden Sie unter „Videoclips“ auf 
Seite 1278.

Erstellen neuer Clips
Pro Tools bietet Ihnen eine Reihe von Befehlen zum 
Erzeugen von Clips und Clipgruppen. Jeder dieser 
Befehle wirkt sich etwas anders auf die Selektion 
aus. Ein neu erzeugter Clip oder eine Clipgruppe 
wird in die Clipliste sowie in die Playlist der Spur 
aufgenommen. Wenn Sie einen neuen Clip aus 
einem bestehenden erzeugen, bleibt der 
ursprüngliche Clip in der Clipliste erhalten. Neue 
Clips werden automatisch benannt (siehe „Optionen 
zur automatischen Benennung“ auf Seite 278). 

Capture Clip-Befehl
Mit dem Capture Clip-Befehl definieren Sie eine 
Selektion als neuen Clip. Der neue Clip erscheint 
dann in der Clipliste. Von dort aus kann er auf eine 
beliebige Spur gezogen werden.

So erzeugen Sie einen neuen Clip mit dem Capture 
Clip-Befehl:

1 Ziehen Sie mit dem Selector-Tool in einem 
bestehenden Clip, um das Material für den 
neuen Clip zu selektieren.

Auswahl eines Bereichs eines Clips
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2 Wählen Sie Clip > Capture.

3 Geben Sie einen Namen für den neuen Clip ein 
und klicken Sie auf OK.

Der neue Clip erscheint in der Clipliste. Der 
ursprüngliche Clip bleibt unverändert erhalten.

Separate-Befehle
Mit den Separate-Befehlen wird eine Selektion 
innerhalb eines vorhandenen Clips oder ein 
teilweise selektierter Clip als neuer Clip definiert 
und vom angrenzenden Material abgetrennt 
(separiert). Die Separate-Befehle können auch auf 
MIDI-Noten angewendet werden (siehe 
„Separieren von MIDI-Noten“ auf Seite 705).

Die neuen Clips erscheinen in der Spur, in der 
sie erstellt werden, abgetrennt von den sie 
umgebenden Daten. Sie werden außerdem in der 
Clipliste angezeigt. 

Es gibt drei unterschiedliche Separate-Befehle:

At Selection (oder am Edit-Cursor). – erstellt 
neue Clipgrenzen an den Start- und Endpunkten 
der Selektion. Falls keine Selektion vorhanden und 
der Edit-Cursor innerhalb des Clips platziert ist, 
wird der Clip am Einfügepunkt in zwei neue Clips 
geteilt. Ebenso können MIDI-Noten an den Start- 
und Endpunkten der Selektion abgetrennt werden 
(oder am Edit-Cursor).

On Grid. – erstellt neue Clips entsprechend dem 
ausgewählten Grid-Wert (siehe „Festlegen des 
Rasterwerts“ auf Seite 859). Ebenso können 
MIDI-Noten im Raster abgetrennt werden.

At Transients. – erstellt automatisch Clipgrenzen 
auf festgestellten Signalspitzen innerhalb einer 
Selektion. Dabei wird der gleiche Algorithmus für 
die Feststellung von Signalspitzen verwendet wie 

bei der Tab To Transients-Funktion (siehe 
„Springen zu Signalspitzen“ auf Seite 587). 
Bei Elastic Audio-fähigen Spuren verwendet der 
Separate At Transients-Befehl die Signalspitzen-
Events, die bei der Elastic Audio-Analyse ermittelt 
wurden (siehe „Elastic Audio-Analyse“ auf 
Seite 910). Separate At Transients gilt nur für 
Audiomaterial und kann auf MIDI-Noten oder -
Clips nicht angewendet werden.

So trennen Sie eine oder mehrere Clips (oder MIDI-
Noten) an der Selektion (oder dem Edit-Cursor) ab:

1 Sie haben folgende Möglichkeiten:

• Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion vor.

• Klicken Sie mit dem Selector-Tool auf den 
Punkt, an dem Sie den Clip (oder die MIDI-
Note) abtrennen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Separate > At Selection.

• Klicken Sie bei einer Edit-Selektion mit der 
rechten Maustaste in die Nähe der Cursor-
Position oder Selektion und wählen Sie aus dem 
Popup-Menü Separate.

3 Wenn in den Editing-Voreinstellungen die Auto-

Name Separated Clips-Option deaktiviert ist, 
geben Sie nach Aufforderung einen Namen für 
den neuen Clip ein und klicken Sie auf OK.

So trennen Sie Clips (oder MIDI-Noten) 
entsprechend der aktuellen Rasterauflösung:

1 Treffen Sie eine Edit-Selektion.

2 Wählen Sie Edit > Separate > On Grid.

Drücken Sie Strg + R (Windows) bzw. 
Befehl + R (Mac).

Drücken Sie Strg + E (Windows) für die 
Funktion „Separate At Selection“.
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3 Geben Sie im Dialogfeld „Pre-Separate 
Amount“ einen Zeitraum vor dem Abtrennen 
(in Millisekunden) ein. Dies kann nützlich sein, 
um die Anfänge des neuen Clips zu füllen.

4 Klicken Sie auf OK.

So trennen Sie Audioclips an Signalspitzen ab:

1 Treffen Sie eine Edit-Selektion.

2 Wählen Sie Edit > Separate > At Transients.

3 Geben Sie im Dialogfeld „Pre-Separate 
Amount“ einen Zeitraum vor dem Abtrennen 
(in Millisekunden) ein. Dies kann nützlich sein, 
um die Anfänge des neuen Clips zu füllen.

4 Klicken Sie auf OK.

Auto-Name Separated Clips-
Option
Wenn in den Editing-Voreinstellungen die Auto-
Name Separated Clips-Option ausgewählt ist, 
gibt Pro Tools den durch Separieren entstandenen 
Clips automatisch einen Namen. Dieser Name 
wird aus dem Namen des ursprünglichen Clips und 
einer Zahl gebildet.

Beim Trennen eines Clips werden aus den Daten auf 
beiden Seiten der separierten Selektion automatisch 
weitere Clips erzeugt und ihren Namen neue 
Nummern zugewiesen. Der ursprüngliche Clip bleibt 
unverändert in der Clipliste erhalten.

“Separate Clip” Operates On All 
Related Takes
Wenn in den Editing-Voreinstellungen die Option 
“Separate Clip” Operates on All Related Takes 
aktiviert ist, hat die Bearbeitung eines Clips mit 
dem Separate Clip-Befehl auch Auswirkungen auf 
alle anderen zusammengehörenden Takes mit 
demselben User Time Stamp-Wert.

Diese Option ermöglicht es, analoge Abschnitte 
einer Gruppe verwandter Takes miteinander zu 
vergleichen. Sie können etwa eine ganze Gruppe 
verwandter Gesangsaufnahmen in Abschnitte 
einteilen, sie abhören und die beste Version jedes 
Abschnitts auswählen.

Wenn diese Option aktiviert ist, sollten auch die 
Optionen Track Name und Clip Start and End 
im Matching Criteria-Fenster aktiviert sein 
(siehe„Matching Criteria-Fenster“ auf Seite 657). 
Ist dies nicht der Fall, wirkt sich dieser Vorgang 
auf alle Clips in den Sessions mit demselben User 
Time Stamp-Wert aus.

In den meisten Fällen empfiehlt es sich, 
die Separate Clip Operates On All Related Takes-
Option zu deaktivieren, um zu vermeiden, dass mit 
Separate Clip eine große Anzahl an Clips 
erstellt wird.

Pre-Separate Amount-Dialogfeld

Die Clipliste kann schnell mit automatisch 
erstellten Clips aufgefüllt werden. 
Deaktivieren Sie zur leichteren Verwaltung 
von Clips im Cliplisten-Menü „Show > Auto-
Created“, um alle automatisch erstellten 
Clips in der Clipliste auszublenden.
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Separieren von Clips auf 
mehreren Spuren
Die folgende Abbildung veranschaulicht das 
Separieren von Clips über eine Mono-Audiospur 
und zwei Stereospuren hinweg. Auf manchen 
Spuren befindet sich die Selektion inmitten eines 
Clips, während sie auf einer anderen Spur den 
Anfang oder das Ende eines Clips bildet.

Nach dem Separieren kann das Material an eine 
andere Position verschoben oder kopiert werden.

Separation Grabber-Tool
Sie können das Separation Grabber-Tool 
verwenden, um eine Edit-Selektion automatisch 
abzutrennen (zu separieren) und auf eine andere 
Position oder eine andere Spur zu verschieben.

So separieren Sie eine Selektion mit dem 
Separation Grabber-Tool:

1 Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion vor. Die Selektion kann sich auf einen 
einzelnen Clip beschränken oder sich über 
benachbarte Clips auf derselben Spur oder auch 
über mehrere Spuren hinweg erstrecken.

2 Wählen Sie aus dem Popup-Menü des Grabber-
Tools das Separation Grabber-Tool aus.

3 Ziehen Sie die Selektion auf die neue Position 
oder auf eine andere Spur.

Separieren über mehrere Spuren hinweg

Separation Grabber-Tool

Verschieben nach „hinten“ mit dem Separation 
Grabber-Tool
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Anhand der vorherigen Selektion entstehen 
ein oder mehrere Clips, die separat von der 
ursprünglichen Selektion sind. Auch das 
Material links und rechts der ursprünglichen 
Selektion wird zu neuen Clips.

So separieren Sie eine Selektion, ohne die 
ursprünglichen Clips zu verändern:

1 Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion vor. Die Selektion kann sich auf einen 
einzelnen Clip beschränken oder sich über 
benachbarte Clips auf derselben Spur oder auch 
über mehrere Spuren hinweg erstrecken.

2 Wählen Sie aus dem Popup-Menü des Grabber-
Tools das Separation Grabber-Tool aus.

3 Ziehen Sie die Selektion bei gedrückter Alt-
Taste (Windows) bzw. Wahltaste (Mac) auf 
die neue Position oder auf eine andere Spur.

Aus der Selektion werden neue Clips erzeugt und 
an der neuen Position platziert. Die ursprüngliche 
Selektion und die Clips bleiben 
unverändert erhalten.

Überlappen und Verdecken 
von Clips
Bei tickbasierten Audiospuren mit mehreren Clips 
kann eine Temposteigerung zu einer Überlappung 
von angrenzenden Clips führen. Bei überlappenden 
Clipgrenzen kann auf Wunsch eine Art „Eselsohr“ 
angezeigt werden. 

So wechseln Sie zwischen der Anzeige von 
verdeckenden und verdeckten Clipgrenzen:

 Wählen Sie View > Clip > Overlap.

Änderung der Überlappung/Verdeckung 
von Clips

Infolge von Tempoänderungen bei tickbasiertem 
Audiomaterial und anderen Bearbeitungsschritten 
kann es zu einer ungewollten Überlappung von 
Clips kommen. Um dies zu korrigieren, kann ein 
Clip je nach Bedarf in den Vordergrund oder in 
den Hintergrund verschoben werden.

So verschieben Sie überlappende Clips in den 
Vorder- bzw. Hintergrund:

1 Wählen Sie im Edit-Fenster den Clip oder die 
Clips, die Sie neu anordnen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Bring to Front, um den Clip 
über die angrenzenden Clips zu legen.

• Wählen Sie Clip > Send to Back, um den Clip 
unter die angrenzenden Clips zu legen. 

Wenn mehrere überlappende Clips selektiert 
wurden, wendet Pro Tools den Befehl auf alle Clips 
in Bezug auf den rechts daneben liegenden Clip an. 

Ziehen auf eine andere Spur mit dem Separation 
Grabber-Tool

Überlappen und Verdecken von Clips

Verdeckender Clip

Verdeckter Clip

Verdeckender Clip
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Zusammenfügen separierter 
Clips
Mit dem Heal Separation-Befehl können 
separierte Clips wieder zusammengefügt werden. 
Voraussetzung dafür ist, dass die Clips immer 
noch nebeneinander liegen und ihre relativen 
Start- und Endpunkte nach dem Separieren nicht 
verändert wurden.

Wurden die Start- und Endpunkte der beiden Clips 
getrimmt oder anderweitig verändert oder wurden 
die Clips weiter auseinander geschoben, können 
sie mit dem Heal Separation-Befehl nicht wieder 
zusammengefügt werden. Es ist nicht möglich, 
zwei Clips zusammenzufügen, die aus 
verschiedenen Audiodateien erstellt wurden.

So fügen Sie separierte Clips wieder zusammen:

1 Selektieren Sie mit dem Selector-Tool einen 
Abschnitt, der einen Teil des ersten Clips, den 
gesamten Zwischenraum zwischen den beiden 
Clips sowie einen Teil des zweiten Clips umfasst.

2 Wählen Sie Edit > Heal Separation.

Wenn die Clips mithilfe von „Heal Separation“ 
nicht zusammengefügt werden, führen Sie einen 
der folgenden Schritte aus, um die separierten 
Clips zu einem einzelnen Clip zusammenzufassen:

 Löschen Sie einen der beiden getrennten Clips 
(wobei der Slip-Modus aktiviert sein muss, damit 
die Lücke nicht geschlossen wird) und erweitern 
Sie mit dem Trim-Tool den verbleibenden Clip auf 
die ursprüngliche Länge (siehe „Verwenden des 
Trim-Tools“ auf Seite 558).

 Löschen Sie die beiden separierten Clips und 
ziehen Sie den ursprünglichen Clip aus der 
Clipliste auf seine ursprüngliche Position 
(siehe „Platzieren von Clips auf Spuren“ auf 
Seite 849).

Trimmen von Clips
Neben den Trim-Tools (siehe „Verwenden des 
Trim-Tools“ auf Seite 558) bietet Pro Tools 
verschiedene Optionen zur Bearbeitung der 
Grenzen von Clips und Clipgruppen. 

Trim To Selection-Befehl
Mit dem Trim To Selection-Befehl werden alle 
Daten vor und nach dem selektierten Teil eines 
Clips bzw. vor und nach einer Selektion von 
MIDI-Noten entfernt (getrimmt), das heißt, nur die 
Selektion bleibt erhalten. Dieser Befehl ist damit 
ein hilfreiches Werkzeug, um alle Daten eines 
Clips (und manchmal der gesamten Spur) mit 
Ausnahme der aktuellen Selektion zu löschen.

So entfernen Sie unerwünschte Daten aus einem 
Clip oder einer Note:

1 Selektieren Sie mit dem Selector-Tool einen 
Bereich eines Clips bzw. einer Note 
(oder Notengruppe).

2 Wählen Sie Edit > Trim Clip > To Selection, 
um das Material um die Selektion herum 
zu entfernen.

Trim to Insertion-Befehle
Sie können einen Clip oder eine MIDI-Note 
trimmen, indem Sie das Material zwischen dem 
Edit-Einfügepunkt und dem Endpunkt des Clips 
automatisch entfernen lassen.

So trimmen Sie ab dem Startpunkt bis 
zum Einfügepunkt:

1 Klicken Sie mit dem Selector-Tool in dem Clip 
bzw. der Note auf die Stelle, an der Sie den 
neuen Startpunkt festlegen möchten.

2 Wählen Sie Edit > Trim Clip > Start To Insertion. 
Der Startpunkt des Clips wird automatisch bis 
zum Einfügepunkt getrimmt.

Drücken Sie Strg + H (Windows) bzw. Befehl 
+ H (Mac), um den Heal Separation-
Befehl auszuführen.
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So trimmen Sie ab dem Endpunkt bis 
zum Einfügepunkt:

1 Klicken Sie mit dem Selector-Tool in dem Clip 
bzw. der Note auf die Stelle, an der Sie den 
neuen Endpunkt festlegen möchten.

2 Wählen Sie Edit > Trim Clip > End To Insertion. 
Der Endpunkt des Clips wird automatisch bis 
zum Einfügepunkt getrimmt.

Trim to Fill Selection-Befehle
Mit den Trim to Fill Selection-Befehlen kann 
verdecktes Material in den Lücken zwischen Clips 
bzw. vor und hinter einzelnen Clips wie folgt 
angezeigt werden:

So trimmen Sie ab dem Startpunkt zum Füllen von 
Lücken:

1 Selektieren Sie mit dem Selector-Tool 
mindestens eine Lücke zwischen Clips.

2 Wählen Sie Edit > Trim Clip > Start To Fill 

Selection.

Der Startpunkt des Clips hinter der Lücke wird 
automatisch bis zum vorhergehenden Clip bzw. so 
weit wie möglich getrimmt (erweitert), falls nicht 
genügend verdecktes Material zum Ausfüllen der 
Lücke verfügbar ist.

So trimmen Sie ab dem Endpunkt zum Füllen 
von Lücken:

1 Selektieren Sie mit dem Selector-Tool 
mindestens eine Lücke zwischen Clips.

2 Wählen Sie Edit > Trim Clip > End To Fill 

Selection. 

Drücken Sie Alt + Umschalt + 7 (Windows) 
bzw. Wahl + Umschalt + 7 (Mac), um den 
Trim-Befehl „Start To Insertion“ auszuführen.

Ende eines Clips bis zum Einfügepunkt getrimmt

Drücken Sie Alt + Umschalt + 8 (Windows) 
bzw. Wahl + Umschalt + 8 (Mac), um den 
Trim-Befehl „Start To Insertion“ auszuführen.

Zum Ausfüllen der Lücke getrimmter Clipanfang
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Der Endpunkt des Clips vor der Lücke wird 
automatisch bis zum nächsten Clip bzw. so weit 
wie möglich getrimmt (erweitert), falls nicht 
genügend verdecktes Material zum Ausfüllen der 
Lücke verfügbar ist.

So trimmen Sie ab dem Start- oder Endpunkt eines 
Clips, um die Edit-Selektion zu füllen:

1 Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion vor, die den Clip umfasst, den Sie 
trimmen möchten.

2 Wählen Sie Edit > Trim Clip > To Fill Selection.

Der Startpunkt des Clips wird automatisch zum 
Start der Edit-Selektion getrimmt (erweitert). 
Reicht das enthaltene Material nicht zum 
Abdecken des Clips, wird der Startpunkt nur so 
weit wie möglich erweitert. Der Endpunkt des 
Clips wird automatisch zum Ende der Edit-
Selektion getrimmt (erweitert). Reicht das 
enthaltene Material nicht zum Abdecken des Clips, 
wird der Endpunkt nur so weit wie möglich 
erweitert.

Der Trim to Fill Selection-Befehl ist die 
Umkehrung des Trim to Fit Selection-Befehls: 
Während der Trim to Fill Selection-Befehl einen 
Clip erweitert, sodass er mit der Edit-Selektion 
übereinstimmt, wird ein Clip mit dem Trim to Fit 

Selection-Befehl an die Edit-Selektion angepasst.

Trimmen mit der Nudge-
Funktion
Sie können Start- und Endpunkt eines Clips (bzw. 
von MIDI-Noten) auch um den aktuellen Nudge-
Wert trimmen.

So trimmen Sie den Start- oder Endpunkt eines 
Clips um den Nudge-Wert:

1 Konfigurieren Sie den Nudge-Wert (siehe 
„Festlegen des Nudge-Werts“ auf Seite 607).

2 Selektieren Sie mit dem Time Grabber-Tool den 
Clip, den Sie trimmen möchten.

3 Sie haben folgende Möglichkeiten:

• Halten Sie die Alt-Taste (Windows) bzw. 
Wahltaste (Mac) gedrückt und drücken Sie 
gleichzeitig auf die Plus- (+) oder Minus-Taste 
(–) auf dem Ziffernblock, um den Startpunkt des 
Clips um den Nudge-Wert zu trimmen.

• Halten Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und drücken Sie 
gleichzeitig auf die Plus- (+) oder Minus-Taste 
(–) auf dem Ziffernblock, um den Endpunkt des 
Clips um den Nudge-Wert zu trimmen.

Zum Ausfüllen der Lücke getrimmtes Clipende



Kapitel 27: Editieren von Clips und Selektionen 607

Verschieben von Clips mit 
der Nudge-Funktion
In Pro Tools können Sie Clips (oder MIDI-Noten) 
mit der Nudge-Funktion in präzisen Schritten 
verschieben, indem Sie die Plus-Taste (+) bzw. die 
Minus-Taste (–) auf dem Ziffernblock verwenden. 
Der genaue Wert für die schrittweise 
Verschiebung wird im Nudge Value-Popup-Menü 
festgelegt. Die Nudge-Funktion kann in jedem 
Edit-Modus verwendet werden.

Die Nudge-Funktion kann äußerst praktisch sein, 
wenn es darum geht, den „Groove“ einer 
musikalischen Phrase oder einen Soundeffekt an 
andere Elemente in der Session anzupassen. Da es 
mit Pro Tools möglich ist, Material mit der Nudge-
Funktion bei laufender Wiedergabe zu 
verschieben, können Sie Ihr Material in Echtzeit so 
lange bearbeiten, bis das Timing der Spuren Ihren 
Wünschen entspricht.

Die Nudge-Funktion kann auch verwendet 
werden, um die Position von Automation-
Breakpoints zu ändern. Weitere Informationen 
finden Sie unter „Editieren von 
Automationsdaten“ auf Seite 1102.

Festlegen des Nudge-Werts
Der Nudge-Wert bestimmt, wie weit Clips oder 
Selektionen beim Verwenden der Nudge-Funktion 
verschoben werden. 

Start- und Endpunkte von Selektionen können 
ebenfalls mit der Nudge-Funktion verschoben 
werden (siehe „Verschieben des Start- und 
Endpunkts einer Selektion mit der Nudge-
Funktion“ auf Seite 582). Darüber hinaus können 
Clips um den Nudge-Wert getrimmt werden 
(siehe „Trimmen mit der Nudge-Funktion“ auf 
Seite 606).

So stellen Sie den Nudge-Wert ein:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie aus dem Menü View > Main Counter 
die Zeitskala, die Sie für den Nudge-Wert 
verwenden möchten.

• Um die Zeitskala beizubehalten und ein anderes 
Zeitformat für den Nudge-Wert zu verwenden, 
deaktivieren Sie im Nudge-Wert-Popup-Menü 
die Option Follow Main Time Scale.

2 Führen Sie einen der folgenden Schritte aus, 
um den Nudge-Wert festzulegen:

• Wählen Sie im Edit-Fenster aus dem Nudge-
Wert-Popup-Menü den gewünschten Nudge-
Wert.

• Um einen Nudge-Wert einzustellen, der nicht im 
Nudge-Wert-Popup-Menü enthalten ist, klicken 
Sie auf die Nudge-Wert-Anzeige und geben Sie 
den Wert ein.

Nudge-Wert-Popup-Menü mit Timecode-Anzeige
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Verschieben von Clips um den 
Nudge-Wert

So verschieben Sie einen oder mehrere Clips mit 
der Nudge-Funktion:

1 Konfigurieren Sie den Nudge-Wert (siehe 
„Festlegen des Nudge-Werts“ auf Seite 607).

2 Selektieren Sie mit dem Time Grabber- oder 
Selector-Tool den Clip, die Clips oder die 
Clipgruppen, die mit der Nudge-Funktion 
verschoben werden sollen. Die Clips können 
sich dabei auch auf mehreren Spuren befinden. 
Nur vollständig selektierte Clips werden 
verschoben.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie die Plus-Taste (+) auf dem 
Ziffernblock, um die Selektion um den Nudge-
Wert nach vorn zu verschieben.

• Drücken Sie die Minus-Taste (–), um die 
Selektion um den Nudge-Wert nach links zu 
verschieben.

Der Nudge-Befehl hat immer dieselbe Funktion, 
unabhängig vom Edit-Modus. 
Aneinandergrenzende Clips werden im Shuffle-
Modus überlappt, im Spot-Modus öffnet sich nicht 
das Spot-Dialogfeld und im Grid-Modus rastet das 
Material beim Verschieben nicht am 
nächstgelegenen Rasterpunkt ein.

Verschieben von Clips auf 
mehreren Spuren und in 
Mehrkanalspuren mit der 
Nudge-Funktion
Wenn Sie eine Selektion verschiedener Clips auf 
einer oder mehreren Spuren, die auch 
Stilleabschnitte enthält, mit der Nudge-Funktion 
verschieben, werden alle Automationsdaten 
innerhalb der Stilleabschnitte mit verschoben.

Verschieben um den 
nächsthöheren Nudge-Wert
Sie können Material nicht nur um den aktuell 
eingestellten Nudge-Wert, sondern auch um den 
im Nudge-Popup-Menü an nächster Stelle 
aufgelisteten, höheren Wert verschieben. 

Wenn also der Nudge-Wert beispielsweise auf 
„1 Frame“ eingestellt ist und Sie Ihr Material um 
einen höheren Wert verschieben möchten, können 
Sie es um den Nudge-Wert „10 Frames“ 
verschieben.

So verschieben Sie Material um den 
nächsthöheren Nudge-Wert nach rechts oder 
links:

1 Aktivieren Sie den Befehls-Tastaturfokus (siehe 
„Tastaturfokus“ auf Seite 27). 

2 Selektieren Sie die gewünschten Clips oder 
Noten.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie die Taste „/“ (Schrägstrich), um das 
selektierte Material um den nächsthöheren 
Nudge-Wert nach vorn zu verschieben.

• Drücken Sie M, um die Selektion um den 
nächsten Nudge-Wert nach links zu verschieben.

Wenn der Befehls-Tastaturfokus nicht 
aktiviert ist, drücken Sie Windows + 
Schrägstrich (/) (Windows) bzw. Ctrl + 
Schrägstrich (/) (Mac), um das 
ausgewählte Material um den nächsten 
Nudge-Wert nach vorn zu verschieben. 
Drücken Sie Windows + M (Windows) 
bzw. Ctrl + M (Mac), um das ausgewählte 
Material um den nächsten Nudge-Wert 
nach hinten zu verschieben.
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Verschieben des Inhalts eines 
Clips mit der Nudge-Funktion
Häufig befindet sich der Startpunkt eines Clips an 
der richtigen Position, etwa auf einem SMPTE-
Frame oder auf einem Taktstrich, doch das 
Material innerhalb des Clips setzt zu früh oder zu 
spät ein. Sie können jedoch die Audiowellenform 
oder MIDI-Noten eines Clips mit der Nudge-
Funktion verschieben, ohne den Start- und 
Endpunkt des Clips zu verändern.

Der Inhalt eines Clips kann nur verschoben 
werden, wenn sich vor dessen Startpunkt und nach 
dessen Endpunkt noch Daten befinden, etwa weil 
der Clip getrimmt wurde oder aus einem größeren 
Clip entstanden ist.

So verschieben Sie den Inhalt eines Clips mit der 
Nudge-Funktion, ohne dessen Start- und 
Endpunkt zu verändern:

1 Konfigurieren Sie den Nudge-Wert (siehe 
„Festlegen des Nudge-Werts“ auf Seite 607).

2 Selektieren Sie mit dem Time Grabber-Tool den 
Clip, dessen Inhalt Sie mit der Nudge-Funktion 
verschieben möchten.

3 Halten Sie die Windows-Taste (Windows) bzw. 
die Ctrl-Taste (Mac) gedrückt und drücken Sie 
die Plus-Taste (+) bzw. die Minus-Taste (–) auf 
dem Ziffernblock, um das Material um den 
Nudge-Wert zu verschieben.

Quantisieren von Clips am 
Raster
Mit dem Quantize to Grid-Befehl wird die 
Platzierung selektierter Audio- und MIDI-Clips 
angepasst, sodass ihre Startpunkte (oder Sync-
Punkte, wenn vorhanden) genau an der nächsten 
Rastergrenze ausgerichtet werden.

Um einzelne MIDI-Noten oder Elastic Audio-
Events zu quantisieren, verwenden Sie auf der 
Event Operations-Seite die Option „Quantize“. 
Mit der Option „Quantize“ auf der Event 
Operations-Seite können Sie auch Audioclips 
quantisieren (siehe „Quantize“ auf Seite 937).

So quantisieren Sie einen oder mehrere Clips:

1 Wählen Sie den Grid-Wert aus (siehe 
„Festlegen des Rasterwerts“ auf Seite 859).

2 Selektieren Sie mit dem Selector- oder Time 
Grabber-Tool den Clip oder die Clips, die Sie 
quantisieren möchten. Die Clips können sich 
dabei auf mehreren Spuren befinden. Nur 
vollständig selektierte Clips werden quantisiert.

3 Wählen Sie Clip > Quantize to Grid. Die 
Startpunkte (oder Sync-Punkte) der Clips 
werden an den nächstgelegenen Grenzen für das 
definierte Raster ausgerichtet. 

Bei MIDI-Clips werden nur die Clips quantisiert. 
Alle MIDI-Daten in den Clips (wie beispielsweise 
Noten) werden unverändert verschoben, sodass die 
rhythmischen Relationen erhalten bleiben. 

Bei Elastic Audio-Clips werden nur die Clips 
quantisiert. Alle Elastic Audio-Events in den Clips 
(wie Signalspitzen-Events) werden unverändert 
verschoben, sodass die rhythmischen Relationen 
erhalten bleiben 

Verschieben der Inhalte von Clips mit der Nudge-
Funktion ohne Änderung der Clipgrenzen

Drücken Sie Strg + 0 (Windows) bzw. 
Befehl + 0 (Mac), um den Quantize to Grid-
Befehl auszuführen.
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Bearbeiten von Stereo- und 
Mehrkanalspuren
Clips auf einzelnen Kanälen innerhalb von Stereo- 
und Mehrkanalspuren können nicht unabhängig 
voneinander selektiert werden. Bei solchen Spuren 
ist eine Selektion immer zeitlich gebunden, was 
bedeutet, dass eine mit dem Selector- oder Time 
Grabber-Tool getroffene Selektion jeden 
einzelnen Kanal auf einer Spur mit einbezieht.

Wenn Clips in Mehrkanalspuren mit einem der 
Trim-Tools bearbeitet oder mit dem Time 
Grabber-Tool gezogen werden, wird das Material 
auf allen anderen Kanälen ebenso verändert, da es 
sich um eine Gruppe handelt.

Splitten selektierter Spuren
Um einen Kanal einer Stereospur oder einer 
Mehrkanalspur zu bearbeiten, ohne dabei die 
anderen Kanäle zu beeinträchtigen, können Sie die 
Spur in einzelne Monospuren zerlegen. Wenn die 
Änderungen an dem separierten Material 
vorgenommen worden sind, können Sie es wieder 
zurück auf die ursprünglichen Mehrkanalspuren 
ziehen oder kopieren.

So splitten Sie eine Stereo- oder Mehrkanalspur:

1 Wählen Sie eine oder mehrere Stereo- oder 
Mehrkanalspuren aus (siehe „Selektieren von 
Spuren“ auf Seite 223). 

2 Wählen Sie Track > Split Into Mono. Die in den 
Kanälen der selektierten Spuren enthaltenen 
Clips werden auf neuen Mono-Audiospuren 
platziert.

Die Namen der neuen Spuren basieren auf dem 
Namen der Ausgangsspur und dem Suffix des 
Kanals. Wenn beispielsweise eine Stereospur mit 
dem Namen „Funkit“ gesplittet wird, werden zwei 
neue Spuren mit den Namen „Funkit.L“ und 
„Funkit.R“ erzeugt.

Ausgangs- und Send-Zuweisungen sowie 
Volume- und Pan-Einstellungen bleiben in den 
neuen Spuren erhalten. Den Plug-In-Zuweisungen 
für Stereo und Multi-Mono werden in den neuen 
Spuren Mono-Entsprechungen zugewiesen. 
Mehrkanal-Plug-In-Zuweisungen werden in den 
neuen Spuren jedoch nicht zugewiesen.

Ziehen von Clips auf Stereo- und 
Mehrkanalspuren

Um einzelne MIDI-Noten oder Elastic Audio-
Events zu quantisieren, verwenden Sie auf 
der Event Operations-Seite die Option 
„Quantize“. Mit der Option „Quantize“ auf 
der Event Operations-Seite können Sie auch 
Audioclips quantisieren. Weitere 
Informationen finden Sie unter „Quantize“ 
auf Seite 937.

Ziehen eines Stereo-Clips auf zwei Mono-
Audiospuren
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Beim Ziehen von Clips auf oder von Stereo- oder 
Mehrkanalspuren sollten folgende Regeln beachtet 
werden:

 Wenn die Anzahl der Ausgangsspuren und -
Kanäle mit der Anzahl der Zielspuren und -kanäle 
übereinstimmt, können Sie Clips zwischen 
Mehrkanal- und Monospuren hin- und herziehen.

 Ausgangs- und Zielspuren für die gezogenen 
Clips können unterschiedliche Formate haben. Sie 
können beispielsweise Clips von einer 5.0-Spur 
(mit fünf Kanälen) auf eine Stereo- und drei Mono-
Audiospuren ziehen.

 Beim Ziehen von Mehrkanal-Clips auf 
Monospuren müssen die Zielspuren 
nebeneinander liegen.

 Beim Ziehen von Clips aus verschiedenen 
Monospuren auf eine Mehrkanalspur müssen die 
Monospuren nicht nebeneinander liegen.

Mehrkanal-Clips können auch aus der Clipliste 
gezogen werden, und zwar entweder auf 
Mehrkanalspuren des gleichen Formats oder auf 
Gruppen von Mono-Audiospuren (oder auch auf 
eine Kombination aus beiden). 

Umgekehrt kann eine Reihe einzelner Mono-Clips 
aus der Clipliste auf einen Mehrkanalspur gezogen 
werden, vorausgesetzt, die Anzahl der gezogenen 
Clips stimmt mit der Anzahl der Kanäle auf der 
Zielspur überein.

Clip-Gain
Zum einfachen Abgleich des Gains von Clips 
(früher als Regions bezeichnet) aus verschiedenen 
Quellen in einer Session bietet Pro Tools eine 
clipbasierte Gain-Funktion. Clipbasierter Gain 
wird vor dem Mixer (vor dem Fader und der Plug-
In-Verarbeitung) angewendet. Das ist besonders in 
der Postproduktion beim Arbeiten mit 
Außenaufnahmen und Sample-Librarys hilfreich.

Durch die Möglichkeit, den Clip-Gain für einzelne 
Clips auf einer Spur einzustellen, können Sie die 
relativen Gain-Pegel der Clips abgleichen, ohne 
eine komplexe Lautstärkeautomation für die Spur 
durchführen zu müssen.

Die Clip-Gain-Einstellungen werden mit dem Clip 
gespeichert, sodass Sie Clips mitsamt ihrer Clip-
Gain-Einstellungen verschieben, kopieren und 
einfügen können. Clip-Gain-Einstellungen können 
jetzt aus Media Composer über AAF- und OMF-
Sequenzen exportiert und in Pro Tools importiert 
werden. Ebenso können Clip-Gain-Einstellungen 
aus Pro Tools über eine AAF-Sequenz (nicht 
jedoch OMF) exportiert und in Media Composer 
importiert werden.

Alle Clips haben standardmäßig einen Clip-Gain 
von 0 dB. Mögliche Clip-Gain-Werte rangieren 
von –144 dB bis +36 dB.

Mehrere Clips mit unterschiedlichen (statischen) Clip-
Gains
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Statischer und dynamischer Clip-Gain

Ein einzelner Clip kann entweder statischen oder 
dynamischen Clip-Gain haben. Statischer Clip-
Gain bedeutet, dass es für den gesamten Clip nur 
einen Clip-Gain-Wert gibt (siehe „Einfache Clip-
Gain-Anpassung“ auf Seite 614). Dynamischer 
Clip-Gain bedeutet, dass der Clip-Gain-Wert 
über den Clip hinweg variiert werden kann 
(siehe „Grafische Bearbeitung des Clip-Gains“ auf 
Seite 614).

Clip-Gain-Informations-Anzeige
Wenn die Anzeige der Clip-Gain-Informationen 
aktiviert ist (View > Clip > Clip Gain Info), wird 
am Anfang des Clips in der linken unteren Ecke 
das Clip-Gain-Fader-Symbol angezeigt. Beim 
Verwenden von statischem Clip-Gain wird der 
statische Wert (–144 dB bis +36 dB) rechts vom 
Clip-Gain-Fader-Symbol angezeigt. Bei Clips 
mit dynamischem Clip-Gain (Verwendung 
von Breakpoints) wird der Clip-Gain-Wert 
nicht angezeigt. 

Clip-Gain-Befehle (einschließlich Clip-Gain-
Fader und zugehörige Kontextmenü-Befehle) 
beziehen sich immer auf den einzelnen, 
gesamten Clip.

So blenden Sie das Clip-Gain-Symbol ein 
oder aus:

 Wählen Sie View > Clip > Clip Gain Info (oder 
heben Sie die Selektion auf).

 Drücken Sie Start + Umschalt + 
„=“(Gleichheitszeichen; Windows) bzw. Ctrl + 
Umschalt + „=“ (Gleichheitszeichen; Mac).

Kontextmenü des Clip-Gain-Fader-Symbols

Über einen Rechtsklick auf das Clip-Gain-Fader-
Symbol eines Clips greifen Sie auf die Clip-Gain-
Befehle für den Clip zu. 

Das Kontextmenü für den Clip-Gain-Fader ist 
unabhängig vom Clip-Gain-Untermenü, das durch 
Rechtsklicken auf eine Edit-Selektion aufgerufen 
wird. Beim Rendern der Clip-Gain-Einstellungen 
hat der generierte Clip Handles für das Verlängern 
des Clips, die auf der „Standardlänge für Handle“-
Einstellung in den Bearbeitungs-Voreinstellungen 
basieren.

Clip-Gain umgehen

Wenn Sie im Kontextmenü Bypass Clip Gain 
auswählen, werden die aktuellen Clip-Gain-
Einstellungen umgangen und der Clip wird mit 
einer Gain-Anpassung von 0 dB wiedergegeben.

Clip-Gain löschen

Wählen Sie im Kontextmenü Clear Clip Gain, um 
die Clip-Gain-Einstellungen für den Clip zu löschen.

Clip-Gain rendern

Wählen Sie im Kontextmenü Render Clip Gain, 
um die Clip-Gain-Einstellungen für den Clip zu 
rendern. Nachdem der Clip mit dem neuen Gain 
gerendert wurde, wird die Clip-Gain-Einstellung 
auf 0 dB zurückgesetzt.

Clip-Gain-Linie anzeigen/ausblenden

Wählen Sie im Kontextmenü Show/Hide Clip Gain 
Line, um die Clip-Gain-Linie für alle Clips ein- 
oder auszublenden.

Clip-Gain-Symbol

Kontextmenü des Clip-Gain-Symbols
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Clip-Gain-Linie
In der Clip-Gain-Linie bearbeiten Sie die Clip-
Gain-Einstellungen eines Clips mit Hilfe von 
Breakpoints, ähnlich wie bei der spurbasierten 
Lautstärkeautomation. Anders als bei der 
Lautstärkeautomation sind die Clip-Gain-
Einstellungen jedoch nicht mit der Spur, sondern 
mit den einzelnen Clips verknüpft. Im Edit-Fenster 
kann die Clip-Gain-Linie für alle Clips angezeigt 
oder ausgeblendet werden.

So blenden Sie die Clip-Gain-Linie ein oder aus:

 Wählen Sie View > Clip > Clip Gain Line.

 Drücken Sie Start + Umschalt + „-“ 
(Bindestrich; Windows) bzw. Ctrl + 
Umschalt + „-“ (Bindestrich; Mac).

 Klicken Sie mit der rechten Maustaste auf das 
Clip-Gain-Fader-Symbol eines Clips und 
wählen Sie Show Clip Gain Line oder Hide Clip 

Gain Line.

 Klicken Sie mit der rechten Maustaste auf einen 
Clip und wählen Sie Clip Gain > Show Clip Gain 

Line oder Clip Gain > Hide Clip Gain Line.

Clip-Gain-Linie und Crossfades

Der Clip-Gain wird auf Clipbasis angewendet. 
Beim Crossfading zwischen Clips wird die Clip-
Gain-Linie des ersten Clips in das Fade-Out-
Segment des Crossfades weitergeführt und die 
Clip-Gain-Linie des zweiten Clips beginnt im 
Fade-In-Segment des Crossfades. 
Dementsprechend werden im Crossfade zwei Clip-
Gain-Linien angezeigt: eine für den ersten und 
eine für den zweiten Clip.

Bearbeiten des Clip-Gains
Mit Pro Tools können Sie schnelle und einfache 
Anpassungen an den Gain-Einstellungen für einen 
Clip mit dem Clip-Gain-Fader vornehmen oder zur 
detaillierten Clip-Gain-Regelung das Breakpoint-
Editing auf die Clip-Gain-Linie anwenden. 

Clip-Gain-Linie (mit mehreren Breakpoints)

Die Clip-Gain-Linie wird nur angezeigt, 
wenn die Spurhöhe auf „Klein“ oder größer 
eingestellt ist.

Clip-Gain-Linien vor Anwenden eines Crossfades

Clip-Gain-Linien nach Anwenden eines Crossfades

Ist ein Clip für die Bearbeitung gesperrt und 
Sie versuchen den Clip-Gain zu editieren, 
werden Sie dazu aufgefordert, die Editierung 
abzubrechen oder zuzulassen.
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Einfache Clip-Gain-Anpassung

Mit dem Clip-Gain-Fader-Symbol können Sie 
schnell und einfach Clip-Gain-Anpassungen 
vornehmen.

So erhöhen oder senken Sie den Clip-Gain-Wert 
eines einzelnen Clips:

1 Vergewissern Sie sich, dass die Clip Gain Info-
Option aktiviert ist.

2 Klicken Sie auf das Clip-Gain-Fader-Symbol 
des Clips und ziehen Sie den Clip-Gain-Fader 
nach oben, um den Wert zu erhöhen, oder nach 
unten, um ihn zu senken.

Grafische Bearbeitung des Clip-Gains

Der Clip-Gain kann mit Hilfe von Breakpoints auf 
der Clip-Gain-Linie für einzelne Clips grafisch 
bearbeitet werden. Wenn Sie einen Clip-Gain-
Breakpoint nach oben oder unten ziehen, wird die 
Wertänderung in Zahlen angezeigt. Das Timing 
des Clip-Gain-Breakpoints wird durch Ziehen 
nach links oder rechts geändert. 

Verwenden des Grabber-Tools

Das Grabber-Tool ermöglicht das Hinzufügen, 
Anpassen und Löschen einzelner Clip-Gain-
Breakpoint-Einstellungen.

So fügen Sie einen Clip-Gain-Breakpoint mit Hilfe 
des Grabber-Tools hinzu:

1 Vergewissern Sie sich, dass die Clip Gain Line-
Option aktiviert ist.

2 Wählen Sie das Grabber-Tool.

3 Klicken Sie auf einen Punkt auf der Clip-Gain-
Linie, um einen Breakpoint hinzuzufügen. 
Der Grabber zeigt auf die Linie und zeigt ein 
Pluszeichen (+) an.

Clip-Gain-Fader, Anpassung des statischen Clip-
Gain-Werts

Clip-Gain-Fader, Anpassung aller Breakpoint-Clip-
Gain-Werte

Drücken Sie zur Feinsteuerung während des 
Ziehens am Clip-Gain-Fader die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac).

Hinzufügen eines Clip-Gain-Breakpoints mit dem 
Grabber-Tool

Drücken Sie Start + Umschalt + E 
(Windows) bzw. Ctrl + Umschalt + E (Mac), 
um an der aktuellen Bearbeitungsposition 
einen Clip-Gain-Breakpoint einzufügen.
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So passen Sie den Clip-Gain-Breakpoint mit dem 
Grabber-Tool an:

1 Vergewissern Sie sich, dass die Clip Gain Line-
Option aktiviert ist.

2 Wählen Sie das Grabber-Tool.

3 Klicken Sie auf der Clip-Gain-Linie auf einen 
Breakpoint und ziehen Sie ihn zum Einstellen 
des Gains nach oben oder unten oder zum 
Einstellen des Timings nach links oder rechts. 
Der Gain-Wert in dB wird oberhalb des 
ausgewählten Breakpoints angezeigt.

So löschen Sie einen Clip-Gain-Breakpoint mit 
dem Grabber-Tool:

1 Vergewissern Sie sich, dass die Clip Gain Line-
Option aktiviert ist.

2 Wählen Sie das Grabber-Tool.

3 Klicken Sie bei gedrückter Alt-Taste 
(Windows) oder Wahltaste (Mac) auf den zu 
löschenden Breakpoint. Der Grabber zeigt auf 
die Linie und zeigt ein Minuszeichen (–) an.

Verwenden des Pencil-Tools

Mit dem Pencil-Tool können Sie neue 
Breakpoints erzeugen, indem Sie auf die 
Diagrammlinie klicken. Für das Zeichnen von 
Clip-Gain-Linien können Sie die folgenden 

Formen in Pro Tools verwenden: Freihand, 
Linie, Dreieck, Quadrat und Pencil-Tool 
(Zufall). Die parabolischen und S-Kurven-
Formen des Pencil-Tools sind nicht zum 
Bearbeiten des Clip-Gains verfügbar.

Beim Zeichnen von Clip-Gain-Einstellungen mit 
dem Pencil-Tool sind Sie durch die Grenzen der 
Edit-Selektion beschränkt. Findet jedoch die 
gesamte Stiftgeste außerhalb der Selektion statt, 
werden Clip-Gain-Breakpoints außerhalb der 
Selektion erstellt. 

So fügen Sie Clip-Gain-Breakpoints mit dem 
Pencil-Tool hinzu:

1 Vergewissern Sie sich, dass die Clip Gain Line-
Option aktiviert ist.

2 Aktivieren Sie das Pencil-Tool.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie einmal auf die Clip-Gain-Linie, 
um einen einzelnen Breakpoint hinzuzufügen.

• Ziehen Sie die Clip-Gain-Linie, um mehrere 
Breakpoints zu erstellen.

Einstellen eines Clip-Gain-Breakpoints mit dem 
Grabber-Tool

Löschen eines Clip-Gain-Breakpoints mit dem 
Grabber-Tool

Zeichnen von Clip-Gain-Einstellungen mit dem 
Zufalls-Pencil-Tool

Zeichnen von Clip-Gain-Einstellungen mit dem 
Freihand-Pencil-Tool, beschränkt durch Grenzen der 
Edit-Selektion
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So löschen Sie einen Clip-Gain-Breakpoint mit 
dem Pencil-Tool:

1 Vergewissern Sie sich, dass die Clip Gain Line-
Option aktiviert ist.

2 Aktivieren Sie das Pencil-Tool.

3 Klicken Sie bei gedrückter Alt-Taste 
(Windows) oder Wahltaste (Mac) auf den zu 
löschenden Breakpoint. 

Verwenden des Trim-Tools

Mit dem Trim-Tool können Sie alle selektierten 
Breakpoints nach oben oder unten verschieben, 
indem Sie sie innerhalb der Selektion ziehen. 
Anders als bei der spurbasierten 
Lautstärkeautomation, die beim Trimmen 
gleichzeitig skaliert, bleiben die Dimensionen 
beim Trimmen von Clip-Gain unverändert (Clip-
Gain-Einstellungen behalten ihre vorgegebenen 
Abstände zueinander bei).

So erhöhen bzw. senken Sie ausgewählte Clip-
Gain-Werte mit dem Trim-Tool:

1 Vergewissern Sie sich, dass die Clip Gain Line-
Option aktiviert ist.

2 Selektieren Sie eine Auswahl, die die Clip-
Gain-Einstellungen enthält, die Sie anpassen 
möchten. 

3 Wählen Sie das Trim-Tool.

4 Ziehen Sie in der Selektion über die Clip-Gain-
Linie nach oben oder unten.

Nudge beim Clip-Gain

In Pro Tools können Sie die Clip-Gain-Einstellung 
schrittweise nach oben oder unten anpassen um 
den Wert, der in der Option Nudge Clip Gain By in 
den Editing-Voreinstellungen festgelegt ist. 
Weiterhin können Sie die Clip-Gain-Einstellungen 
im Clip um den festgelegten Nudge-Wert 
schrittweise rückwärts oder vorwärts verschieben.

So legen Sie den Nudge-Wert für den Clip-
Gain fest:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Editing-Registerkarte.

3 Geben Sie den gewünschten Wert für die Nudge 

Clip Gain By-Option ein.

4 Klicken Sie auf OK.

So verschieben Sie den Clip-Gain schrittweise 
nach oben:

 Drücken Sie Start + Umschalt + Pfeil nach oben 
(Windows) bzw. Ctrl + Umschalt + Pfeil nach 
oben (Mac).

So verschieben Sie den Clip-Gain schrittweise 
nach unten:

 Drücken Sie Start + Umschalt + Pfeil nach 
unten (Windows) bzw. Ctrl + Umschalt + Pfeil 
nach unten (Mac).

Erhöhen bzw. Absenken des Clip-Gain-Werts mit dem 
Trim-Tool

Dank EUCON können Sie den Clip-Gain 
schrittweise auf- oder abwärts verschieben. 
Weitere Informationen hierzu finden Sie im 
Artist Series and Pro Tools Guide. 

Wenn Sie eine Radmaus verwenden, 
können Sie das Rad zum schrittweisen 
Verschieben des ausgewählten Clip-Gains 
nach oben oder unten einsetzen. Drücken 
Sie Start + Umschalt (Windows) bzw. 
Ctrl + Umschalt (Mac) und scrollen Sie mit 
dem Mausrad nach oben oder unten.
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So verschieben Sie den Clip-Gain 
schrittweise rückwärts:

 Drücken Sie Start + Umschalt + „–“ (Minus, 
Windows) bzw. Ctrl + Umschalt + „–“ 
(Minus, Mac).

 Drücken Sie Start + Umschalt + M (Windows) 
bzw. Ctrl + Umschalt + M (Mac).

 Drücken Sie Start + Umschalt + „,“ (Komma, 
Windows) bzw. Ctrl + Umschalt + „,“ 
(Komma, Mac).

So verschieben Sie den Clip-Gain 
schrittweise vorwärts:

 Drücken Sie Start + Umschalt + „+“ (Plus, 
Windows) bzw. Ctrl + Umschalt + „+“ 
(Plus, Mac).

 Drücken Sie Strg + Umschalt + „.“ (Punkt, 
Windows) bzw. Ctrl + Umschalt + „.“ 
(Punkt, Mac).

 Drücken Sie Start + Umschalt + „/“ 
(Schrägstrich, Windows) bzw. Ctrl + 
Umschalt + „/“ (Schrägstrich, Mac).

Löschen des Clip-Gains

In Pro Tools können Sie die Clip-Gain-
Einstellungen für die aktuelle Edit-Selektion 
löschen. Dadurch wird der Clip-Gain der Selektion 
auf 0 dB zurückgesetzt. Bei Clips, die nur 
teilweise in der Edit-Selektion liegen, werden 
nur die Clip-Gain-Einstellungen innerhalb der 
Edit-Selektion geändert.

So setzen Sie den Clip-Gain zurück:

 Klicken Sie mit der rechten Maustaste auf einen 
Clip oder auf eine Edit-Selektion und wählen 
Sie Clip Gain > Clear Clip Gain.

 Klicken Sie mit der rechten Maustaste auf das 
Clip-Gain-Fader-Symbol eines einzelnen Clips 
und wählen Sie Clear Clip Gain.

 Wählen Sie einen Clip oder selektieren Sie 
Material und wählen Sie Edit > Clip Special > 

Clear Clip Gain.

 Wählen Sie einen Clip oder selektieren Sie 
Material und drücken Sie Start + Umschalt + B 
(Windows) bzw. Ctrl + Umschalt + B (Mac).

 Drücken Sie die Alt- (Windows) oder die 
Wahltaste (Mac) und klicken Sie auf das Clip-
Gain-Fader-Symbol eines einzelnen Clips.

Ausschneiden, Kopieren und Einfügen 
von Clip-Gain

In Pro Tools können Sie Clip-Gain-Einstellungen 
ausschneiden, kopieren und einfügen, sodass Sie 
den Clip-Gain eines Clips auf einen anderen Clip 
anwenden können. Clip-Gain-Einstellungen 
können nicht über Clipgrenzen hinweg 
ausgeschnitten, kopiert und eingefügt werden.

So schneiden Sie Clip-Gain-Einstellungen aus:

1 Wählen Sie einen einzelnen, vollständigen Clip 
aus oder selektieren Sie Material innerhalb 
eines einzelnen, vollständigen Clips.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Cut Special > Cut Clip Gain.

• Drücken Sie Start + Umschalt + X (Windows) 
bzw. Ctrl + Umschalt + X (Mac).

Die selektierten Clip-Gain-Einstellungen werden 
ausgeschnitten und in die Zwischenablage kopiert. 
Clip-Gain-Breakpoints in der Zwischenablage sind 
mit einem Zeitstempel mit den Wiedergabezeiten in 
der Timebase oder der kopierten Spur versehen. 
Das bedeutet, dass Sie Clip-Gain-Einstellungen von 
Clips auf Tick-basierten Spuren ausschneiden und 
einfügen können, wobei die eingefügten Clip-Gain-
Einstellungen an die Takt|Schlag-Locations der 
Clips auf anderen Tick-basierten Spuren 
angepasst werden.
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So kopieren Sie Clip-Gain-Einstellungen:

1 Wählen Sie einen einzelnen, vollständigen Clip 
aus oder selektieren Sie Material innerhalb 
eines einzelnen, vollständigen Clips.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Copy Special > Copy 

Clip Gain.

• Drücken Sie Start + Umschalt + C (Windows) 
bzw. Ctrl + Umschalt + C (Mac).

• Klicken Sie mit der rechten Maustaste auf eine 
Selektion bestehend aus einem einzelnen, 
vollständigen Clip und wählen Sie Clip Gain > 

Copy Clip Gain.

Die ausgewählten Clip-Gain-Einstellungen 
werden in die Zwischenablage kopiert. Clip-Gain-
Breakpoints in der Zwischenablage sind mit einem 
Zeitstempel mit den Wiedergabezeiten in der 
Timebase oder der kopierten Spur versehen. 
Das bedeutet, dass Sie Clip-Gain-Einstellungen 
von Clips auf Tick-basierten Spuren kopieren und 
einfügen können, wobei die eingefügten Clip-
Gain-Einstellungen an die Takt|Schlag-Locations 
der Clips auf anderen Tick-basierten Spuren 
angepasst werden.

So fügen Sie Clip-Gain-Einstellungen ein:

1 Kopieren Sie die gewünschten Clip-Gain-
Einstellungen oder schneiden Sie sie aus.

2 Sie haben folgende Möglichkeiten:

• Selektieren Sie einen weiteren Clip.

• Selektieren Sie in einem einzelnen, 
vollständigen Clip Material zum Editieren.

• Platzieren Sie den Edit-Auswahl-Startpunkt 
dort, wo Sie die Clip-Gain-Einstellungen 
einfügen möchten.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Paste Clip Gain.

• Drücken Sie Strg + V (Windows) bzw. 
Befehl + V (Mac).

Die Clip-Gain-Einstellungen werden aus der 
Zwischenablage am Edit-Auswahl-Startpunkt in 
den Clip eingefügt. Die Clip-Gain-Einstellungen 
werden vollständig eingefügt, aber nur auf einen 
einzelnen Clip angewendet. Wenn die eingefügten 
Clip-Gain-Einstellungen über das Clipende hinaus 
erweitert werden, bleiben sie trotzdem mit dem 
Clip verknüpft. Das bedeutet, dass der eingefügte 
Clip-Gain sichtbar wird, wenn Sie den Clip später 
verlängern. Wenn Sie Clip-Gain innerhalb eines 
Clips einfügen (also nicht auf die Gesamtdauer 
eines einzelnen, vollständigen Clips anwenden), 
werden vor und nach den eingefügten Daten 
Breakpoints hinzugefügt, damit Clip-Gain-
Einstellungen außerhalb des eingefügten Bereichs 
nicht verändert werden.

Konvertieren von Clip-Gain 
in Lautstärkeautomation 
für Spuren
(Nur Pro Tools HD)

Pro Tools ermöglicht das Umwandeln von Clip-
Gain-Einstellungen in spurbasierte 
Lautstärkeautomation sowie das Umwandeln 
spurbasierter Lautstärkeautomation in Clip-Gain-
Einstellungen. 

Beim Umwandeln von Clip-Gain-Einstellungen 
in Lautstärkeautomation werden die Clip-Gain-
Einstellungen vom Clip ausgeschnitten und in die 
spurbasierte Lautstärkeautomation an derselben 
Timeline-Position wie im Clip eingefügt. 

Clip-Gain-Einstellungen können aus jeder 
Edit-Selektion ausgeschnitten werden. Wenn 
Sie jedoch Clip-Gain-Einstellungen 
ausschneiden und einfügen möchten, können 
Sie nur jeweils die Clip-Gain-Einstellungen 
eines einzelnen Clips einfügen.
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Beim Umwandeln von spurbasierter 
Lautstärkeautomation in Clip-Gain wird die 
Lautstärkeautomation aus der Spurlautstärke-
Automations-Playlist ausgeschnitten und in den 
Clip eingefügt. Sobald die Lautstärkeautomation 
in Clip-Gain umgewandelt wurde, bleiben die 
Clip-Gain-Einstellungen beim Verschieben, 
Ausschneiden, Kopieren und Einfügen mit dem 
Clip verknüpft.

So wandeln Sie Clip-Gain-Einstellungen 
in spurbasierte Lautstärkeautomation um:

1 Wählen Sie einen Clip aus oder nehmen Sie 
eine Edit-Selektion vor.

2 Wählen Sie Edit > Automation > Convert Clip 
Gain to Volume Automation.

So wandeln Sie spurbasierte 
Lautstärkeautomation in Clip-Gain um:

1 Wählen Sie einen Clip aus oder nehmen Sie 
eine Edit-Selektion vor.

2 Wählen Sie Edit > Automation > Convert 
Volume to Clip Gain.

Addieren von Clip-Gain und 
Lautstärkeautomation
(Nur Pro Tools HD)

In Pro Tools können Sie die Werte der Clip-Gain-
Einstellungen zu denen der spurbasierten 
Lautstärkeautomation sowie die Werte 
spurbasierter Lautstärkeautomation zu denen 
der Clip-Gain-Einstellungen addieren. 

Beim Addieren von Clip-Gain-Einstellungen zur 
Lautstärkeautomation werden die Clip-Gain-
Einstellungen vom Clip ausgeschnitten und zur 
spurbasierten Lautstärkeautomation an derselben 
Timeline-Position wie im Clip addiert. 

Beim Addieren von spurbasierter 
Lautstärkeautomation zum Clip-Gain wird die 
Lautstärkeautomation aus der Spurlautstärke-
Automations-Playlist ausgeschnitten und zu den 
Clip-Gain-Einstellungen addiert. Sobald die 
Lautstärkeautomation zum Clip-Gain addiert 
wurde, wird die Lautstärkeautomation für die 
Selektion auf 0 dB gesetzt.

So addieren Sie Clip-Gain-Einstellungen zur 
spurbasierten Lautstärkeautomation:

1 Wählen Sie einen Clip aus oder nehmen Sie 
eine Edit-Selektion vor.

2 Wählen Sie Edit > Automation > Coalesce Clip 
Gain to Volume Automation.

So addieren Sie spurbasierte 
Lautstärkeautomation zum Clip-Gain:

1 Wählen Sie einen Clip aus oder nehmen Sie 
eine Edit-Selektion vor.

2 Wählen Sie Edit > Automation > Coalesce 
Volume to Clip Gain.

Alle Clip-Gain-Einstellungen über +12 dB 
gehen beim Umwandeln in 
Lautstärkeautomation verloren. Außerdem 
können Clip-Gain-Einstellungen innerhalb 
von Crossfades im Rahmen von 
Lautstärkeautomation „gecrossfadet“ 
werden.

Alle Clip-Gain-Einstellungen über +12 dB 
gehen beim Addieren zur 
Lautstärkeautomation verloren. Außerdem 
kann Clip-Gain innerhalb von Crossfades im 
Rahmen von Lautstärkeautomation 
„gecrossfadet“ werden.
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Bypass für Clip-Gain
In Pro Tools können Sie die aktuellen Clip-Gain-
Einstellungen für einen selektierten vollständigen 
Clip auf Bypass schalten. Das bedeutet, dass Sie 
den Clip ohne die Anpassung des Clip-Gains hören 
können, ohne dabei die aktuellen Clip-Gain-
Einstellungen zu verlieren. 

So schalten Sie den Clip-Gain eines Clips auf 
Bypass (oder heben den Bypass auf):

 Wählen Sie einen oder mehrere vollständige 
Clips und wählen Sie Clip > Clip Gain > Bypass 

Clip Gain (oder Clip > Clip Gain > Unbypass 

Clip Gain).

 Klicken Sie mit der rechten Maustaste auf das 
Clip-Gain-Fader-Symbol eines Clips und 
wählen Sie Bypass oder heben Sie die 
Auswahl auf.

 Klicken Sie mit der rechten Maustaste auf eine 
Edit-Selektion und wählen Sie Clip Gain > 

Bypass Clip Gain (oder Clip Gain > Unbypass 

Clip Gain).

Die Clip-Gain-Einstellungen werden für 
vollständige Clips innerhalb der Edit-Selektion 
umgangen (oder der Bypass wird aufgehoben).

Rendern von Clip-Gain
In Pro Tools können Sie die aktuellen Clip-Gain-
Einstellungen für einen selektierten vollständigen 
Clip rendern. Das Rendern von Clip-Gain wendet 
die aktuellen Clip-Gain-Einstellungen auf einen 
neuen Clip an und setzt die Clip-Gain-
Einstellungen für den neuen Clip auf 0 dB.

So rendern Sie den Clip-Gain eines Clips:

 Wählen Sie einen oder mehrere vollständige 
Clips aus und wählen Sie Clip > Clip Gain > 

Render Clip Gain.

 Klicken Sie mit der rechten Maustaste auf das 
Clip-Gain-Fader-Symbol eines Clips und 
wählen Sie Render Clip Gain.

 Klicken Sie mit der rechten Maustaste auf eine 
Edit-Selektion und wählen Sie Clip Gain > 

Render Clip Gain.

Der Clip-Gain für vollständige Clips innerhalb der 
Edit-Selektion wird gerendert und ihre Clip-Gain-
Einstellungen werden auf 0 dB zurückgesetzt.

Bei Clips, die nicht 0 dB als Clip-Gain 
eingestellt haben, rendert der Befehl „Für 
DestructivePunch aktivierte Spuren 
vorbereiten“ automatisch alle Clip-Gain-
Einstellungen und setzt alle Clip-Gain-
Einstellungen auf 0 dB zurück.

Bei der Verarbeitung in einem AudioSuite-
Modus zum Rendern von Clip-Gain werden 
zuerst alle Clip-Gain-Einstellungen 
gerendert, danach wird die AudioSuite-
Verarbeitung angewendet. Der Clip-Gain für 
den generierten Clip wird auf 0 dB 
zurückgesetzt. Beim Erstellen individueller 
Dateien mit AudioSuite oder beim 
Überschreiben von Dateien Clip für Clip 
bleiben die Clip-Gain-Einstellungen jedoch 
erhalten. Weitere Informationen finden Sie 
unter „Bedingungen für das AudioSuite-
Rendering mit Handles, Fades, Clip-Gain 
und Metadaten“ auf Seite 900.
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Konsolidieren von Clips
Während der normalen Bearbeitung kann eine 
Spur sehr viele Clips ansammeln. Wenn Sie jedoch 
auf einer Spur oder in einem Spurabschnitt 
(beispielsweise eine Strophe oder ein Chorus) 
ein zufrieden stellendes Ergebnis erzielt haben, 
können Sie die Clips zu einem einzigen 
Clip zusammenfügen.

Beim Zusammenführen einer vollständigen 
Audiospur oder einer Edit-Selektion wird eine 
neue Audiodatei geschrieben, die aus der 
vollständigen Selektion besteht, einschließlich der 
leeren Bereiche. 

Bei der Konsolidierung werden stummgeschaltete 
Clips als stille Passagen behandelt. Ansonsten hat 
es keine Auswirkung auf den Consolidate-Befehl, 
ob eine Spur stummgeschaltet ist oder nicht bzw. 
ob sie eine Stummschaltungsautomation 
enthält oder nicht.

So fügen Sie Clips auf einer Spur zusammen:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie mit dem Time Grabber- oder 
Selector-Tool die Clips aus, die Sie 
zusammenfügen möchten. 

• Um alle Clips der Spur zu selektieren, 
klicken Sie mit dem Selector-Tool dreimal 
in deren Playlist.

2 Wählen Sie Edit > Consolidate.

Komprimieren einer 
Audiodatei
Mit dem Compact-Befehl können Sie 
ungenutzte Teile von Audiodateien löschen, 
um so Festplattenspeicher zu sparen und die 
Voraussetzungen für Festplatten-Backups zu 
verbessern. Mit dem Compact Selected-Befehl 
werden auch Audiodateien gelöscht, für die es 
keine Clips auf Spuren gibt, die auf diese 
Dateien verweisen.

Da die Audiodaten mit dem Compact-Befehl 
dauerhaft gelöscht werden, sollten Sie ihn erst 
nach Abschluss sämtlicher Editiervorgänge 
benutzen, wenn Sie sicher sind, dass Sie die 
betreffenden Audiodaten nicht mehr benötigen.

Beim Compact-Befehl haben Sie die Möglichkeit, 
einen bestimmten zusätzlichen Datenbereich als 
Polster am Anfang und am Ende der Clips in der 
komprimierten Datei zu belassen. Wenn Clips in 
der Session also Crossfades enthalten oder Sie ein 
gewisses „Polster“ für ein späteres Trimmen 
benötigen, sollten Sie einen angemessenen 
Zeitraum (in Millisekunden) eingeben.

So komprimieren Sie eine Audiodatei:

1 Selektieren Sie in der Clipliste die zu 
komprimierenden Clips.

2 Wählen Sie im Clip List-Menü Compact.

3 Geben Sie den Zeitraum (in Millisekunden) ein, 
den jeder Clip in der Datei zusätzlich 
aufweisen soll.

4 Klicken Sie auf Compact, um die Datei zu 
komprimieren, oder auf Cancel, um den 
Befehl abzubrechen. 

Wenn der Compact-Befehl abgeschlossen ist, wird 
die Session automatisch gespeichert.

Beim Zusammenfügen einer Audiospur 
werden die zugrunde liegenden 
Automationsdaten nicht zusammengefügt. 
Zur Erstellung einer einzigen Datei, die die 
auf das Audiomaterial angewendeten 
Automationsdaten enthält, verwenden Sie 
den Bounce to Disk-Befehl (siehe „Bounce to 
Disk“ auf Seite 1141).

Drücken Sie Alt + Umschalt + 3 (Windows) 
bzw. Wahl + Umschalt + 3 (Mac), um den 
Consolidate-Befehl auszuführen.

Der Compact-Befehl arbeitet destruktiv und 
lässt sich nicht rückgängig machen. Er 
verändert die ursprünglichen Audiodateien 
unwiderruflich. Daten, die mit diesem Befehl 
gelöscht wurden, können nicht 
wiederhergestellt werden.
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Bearbeiten von Audio mit 
AudioSuite-Plug-Ins
Die im Lieferumfang Ihres Pro Tools-Systems 
inbegriffenen AudioSuite-Plug-Ins können 
verwendet werden, um einen Audioclip oder eine 
komplette Audiodatei zu bearbeiten und zu ändern. 
Wenden Sie dazu einen bestimmten AudioSuite-
Vorgang (wie „Normalization“ oder „DC Offset 
Removal“) auf eine beliebige Anzahl von 
Audioclips in der Session an.

TCE (Time Compression and 
Expansion) Edit To Timeline 
Selection
(Nur Pro Tools HD)

Wenn Edit- und Timeline-Selektion nicht 
miteinander gekoppelt sind, können Sie eine 
Audioselektion komprimieren oder dehnen, 
um sie der Timeline-Selektion anzupassen. 
Bei Audiospuren verwendet TCE Edit to Timeline 

Selection das AudioSuite-Plug-In für TCE, das in 
den Processing-Voreinstellungen ausgewählt ist 
(siehe „Processing-Voreinstellungen“ auf 
Seite 125). Bei Elastic Audio-fähigen Spuren 
verwendet TCE Edit To Timeline Selection das 
ausgewählte Elastic Audio-Plug-In für die Spur 
(siehe „Elastic Audio-Plug-Ins“ auf Seite 913).

So passen Sie eine Edit-Selektion an die 
Timeline an:

1 Deaktivieren Sie Options > Link Timeline and 

Edit Selection.

2 Selektieren Sie mit dem Selector-Tool das 
Audiomaterial, das Sie komprimieren oder 
dehnen möchten.

3 Selektieren Sie in einer der Zeitbasis-Leisten 
einen Zeitabschnitt, an den das Audiomaterial 
angepasst werden soll.

4 Wählen Sie Edit > TCE Edit to Timeline 

Selection. Die Edit-Selektion wird auf die 
Länge der Timeline-Selektion komprimiert 
oder gedehnt.

TCE Edit to Timeline 
Selection auf mehreren 
Spuren und Kanälen
Der TCE Edit to Timeline-Befehl kann auch auf 
Mehrkanal-Selektionen und Selektionen über 
mehrere Spuren hinweg angewendet werden. 
Dabei werden alle Clips in Abhängigkeit von 
der Edit-Selektion gleichmäßig um den gleichen 
Prozentwert komprimiert oder gedehnt. Dadurch 
wird sichergestellt, dass die rhythmischen 
Relationen zwischen den einzelnen Kanälen oder 
Spuren erhalten bleiben.

Anpassen eines Audioclips an 
eine Edit-Selektion
Clips können direkt aus der Clipliste auf eine Edit-
Selektion gezogen werden, um sie an deren Länge 
anzupassen. Der gezogene Clip wird je nach Länge 
der Edit-Selektion entweder komprimiert oder 
gedehnt. Bei Audiospuren wird für die Anpassung 
eines Audioclips an die Edit-Selektion das 
AudioSuite-Plug-In für TCE verwendet, das in 
den Processing-Voreinstellungen ausgewählt 
ist (siehe „Processing-Voreinstellungen“ auf 
Seite 125). Bei Elastic Audio-fähigen Spuren wird 
das ausgewählte Elastic Audio-Plug-In für die 
Spur verwendet (siehe „Elastic Audio-Plug-Ins“ 
auf Seite 913).

Weitere Informationen zu AudioSuite-
Plug-Ins finden Sie unter Kapitel 39: 
„AudioSuite“.
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So passen Sie einen Audioclip an eine Edit-
Selektion an:

1 Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion auf einer Audiospur vor.

2 Ziehen Sie den Clip bei gedrückter Strg- und 
Alt-Taste (Windows) bzw. Befehls- und 
Wahltaste (Mac) aus der Clipliste auf die 
Selektion auf der Spur. Der Startpunkt des Clips 
wird auf dem Startpunkt der Selektion 
positioniert und der Clip wird entsprechend der 
Länge der Selektion komprimiert oder gedehnt.

Fit to Selection-Befehl auf 
mehreren Spuren bzw. Kanälen
Mit dem Fit to Selection-Befehl können auch 
mehrere Clips aus der Clipliste auf mehrere Spuren 
oder Mehrkanalspuren gezogen werden.

Alle verschobenen Clips werden auf Basis der 
Länge des vor dem Ziehen zuletzt angeklickten 
Clips um den gleichen Prozentwert komprimiert 
oder gedehnt.

Bewerten von Clips
Sie können verschiedene Clips auf einer Skala von 
1 bis 5 bewerten, wobei 5 die Höchstwertung 
(am besten) und 1 die schlechteste Wertung ist. 
Die Bewertung von Clips hilft Ihnen dabei, 
festzustellen, welche Takes (Clips) Ihnen beim 
Zusammenstellen von Playlists am besten 
gefallen. Sie können die Clip-Bewertung ein- oder 
ausblenden, um das Spur-Compositing oder die 
konventionelle Editierung zu erleichtern. Sie 
haben außerdem die Möglichkeit, Playlist-Lanes 
basierend auf den Bewertungen von Clips in der 
Playlist ein- oder auszublenden (siehe „Filtern von 
Lanes“ auf Seite 656).

So bewerten Sie einen Clip:

1 Selektieren Sie den Clip.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Rating und vergeben Sie eine 
Bewertung von 1 bis 5. 

• Klicken Sie mit der rechten Maustaste auf den 
Clip, wählen Sie Rate und vergeben Sie eine 
Bewertung von 1 bis 5. 

So zeigen Sie Bewertungen in Clips an:

 Aktivieren Sie die Option View > Clip > Rating.

So blenden Sie Bewertungen in Clips aus:

 Deaktivieren Sie die Option View > Clip > Rating.

Sie können ausgewählte Clips während der 
Wiedergabe bewerten, indem Sie Strg + Alt + 
Windows (Windows) bzw. Befehl + Wahl + 
Ctrl (Mac) drücken und dann die Bewertung 
(1 bis 5) auf dem Ziffernblock eingeben.

Clip mit angezeigter Bewertung
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Kapitel 28: Fades und Crossfades

Pro Tools berechnet Fades und Crossfades 
im Systemspeicher in Echtzeit. Sie können 
problemlos Fade-Ins oder Fade-Outs auf einen 
Audioclip bzw. Crossfades zwischen 
angrenzenden Audioclips anwenden. Als 
Crossfading wird der Prozess des Fadings 
zwischen zwei Clips mit Audiomaterial zur 
Vermeidung von Knacken, Klicken oder 
plötzlichen Klangänderungen bezeichnet. 
Für Crossfades gibt es viele Anwendungen, 
die vom Glätten der Übergänge zwischen Clips 
bis zum Erzeugen von speziellen Audioeffekten 
reicht. Die Dauer, Position und Form des 
Crossfades können vom Anwender definiert 
werden. 

Crossfades und 
Kurvenverläufe
Verwenden Sie zum Erzeugen eines Crossfades 
zwischen zwei Clips das Selector-Tool, um die 
Selektion über den Endpunkt des ersten Clips und 
den Startpunkt des zweiten vorzunehmen. Die 
Länge dieses Bereichs ist ausschlaggebend für die 
Länge des Crossfades. Obwohl Fades eventuell 
wie eigenständige Clips erscheinen, können sie 
nicht von den Clips, zwischen denen sie erzeugt 
wurden, getrennt werden. Sie können jedoch 
jederzeit Fade-Ins und Fade-Outs für einzelne 
Clips erzeugen (siehe „Erzeugen von Fades am 
Anfang und Ende von Clips“ auf Seite 633).

Mithilfe des Fades-Dialogfelds können Sie die 
Kurven für Fades und Crossfades auswählen, 
anzeigen und bearbeiten. Den Fade-Out- und 
Fade-In-Abschnitten können unterschiedliche 
Kurvenverläufe zugewiesen werden. Das Fades-
Dialogfeld kann ebenfalls verwendet werden, 
um einen Fade oder Crossfade abzuhören, bevor 
dieser angewendet wird.

Die Art der Selektion ist ausschlaggebend für den 
Charakter des Crossfades.

 Da Crossfades nur dort erzeugt werden 
können, wo das Audiomaterial überlappt, 
können Sie keine Crossfades generieren, 
wenn der selektierte Abschnitt eines dieser 
Clips kein Audiomaterial enthält.
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Standard-Crossfade (zentriert)

Eine solche Selektion erzeugt einen Crossfade 
auf beiden Seiten des Berührungspunkts, der die 
Lautstärke von Clip 1 und Clip 2 beeinflusst. Dies 
ist der am häufigsten verwendete Crossfade-Typ.

Für einen zentrierten Crossfade müssen Clip 1 
nach dem Endpunkt und Clip 2 vor dem Startpunkt 
Audiomaterial enthalten.

Pre-Crossfade

Eine solche Selektion erzeugt einen Crossfade, 
der links vom Berührungspunkt liegt. Auf diese 
Weise können Sie die Lautstärke am Anfang von 
Clip 2 beibehalten und müssen sie nicht 
überblenden. Dies ist dann sinnvoll, wenn die 
Attack-Phase am Anfang von Clip 2 sehr stark 
ist und Sie dies nicht ändern möchten. Bei der 
Vornahme von Selektionen für Crossfades, die an 
der Grenze zwischen zwei Clips auftreten, können 
Sie die Tab-Taste verwenden, um den Cursor 
genau an den Anfang oder das Ende eines Clips zu 
verschieben.

Bei diesem Crossfade-Typ ist es notwendig, dass 
Clip 2 vor dem Startpunkt Audiomaterial enthält.

Post-Crossfade

Eine solche Selektion erzeugt einen Crossfade, der 
rechts vom Berührungspunkt liegt. Ein Post-
Crossfade ist dann nützlich, wenn Sie die 
Amplitude von Clip 1 bis zum Ende beibehalten 
möchten. Bei der Vornahme von Selektionen für 
Crossfades, die an der Grenze zwischen zwei Clips 
auftreten, können Sie die Tab-Taste verwenden, 
um den Cursor genau an den Anfang oder das Ende 
eines Clips zu verschieben.

Bei diesem Crossfade-Typ ist es notwendig, 
dass Clip 1 nach ihrem Endpunkt 
Audiomaterial enthält.

Wenn ein Clip nicht ausreichend Daten 
für ausgewählte Fades oder Crossfades 
referenziert, müssen Sie entweder diese 
Fades auslassen oder die Grenzen der 
Selektion anpassen, um diese Fades 
auszuführen.

Zentrierter Crossfade

Pre-Crossfade

Clip 2Clip 1

Fade-Out-Kurve
Berührungspunkt

Fade-In-Kurve

Crossfade-Selektion

Clip 2Clip 1 Clip 2Clip 1

Berührungspunkt

Crossfade-Selektion

Post-Crossfade

Clip 2Clip 1

Berührungspunkt

Crossfade-Selektion
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Crossfade-Überlappungs-Ansicht
Pro Tools zeigt Ihnen die überlappenden 
Wellenformen in Crossfades. 

So zeigen Sie die überlappenden Crossfades an 
(oder blenden sie aus):

 Aktivieren (oder deaktivieren) Sie die Option 
View > Waveform > Overlapping Crossfades.

Fades-Dialogfeld
Wenn Sie den Befehl Edit > Fades wählen, können 
Sie mithilfe des Fades-Dialogfelds Fades und 
Crossfades auswählen, darstellen und im 
Voraus abhören sowie die Kurven von Fades 
und Crossfades bearbeiten. Für einen Fade-In 
werden die In Shape-Einstellungen, aber nicht 
die Out Shape-Einstellungen angezeigt. Ähnliches 
gilt für einen Fade-Out, für den die Out Shape-
Einstellungen, aber nicht die In Shape-
Einstellungen verfügbar sind.

Im Fades-Dialogfeld gibt es folgende 
Steuerelemente:

Audition. 

Klicken Sie auf diese Schaltfläche, um die Fades 
abzuhören. Pro Tools unterstützt das Abhören 
von Fades direkt über die Ausgänge eines Audio-
Interface.

View First Track (nur Crossfades). 

Wenn Sie Crossfades zwischen mehreren Spuren 
nutzen möchten, können Sie diese Schaltfläche 
verwenden, um das Audiomaterial auf der 
ersten der aneinandergrenzenden Spuren eines 
Spurenpaares darzustellen und abzuhören.

Crossfade-Überlappungs-Ansicht

Fades-Dialogfeld mit Fade-Out

Fades-Dialogfeld mit Crossfade
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View Second Track (nur Crossfades). 

Wenn Sie Crossfades zwischen mehreren Spuren 
nutzen möchten, können Sie diese Schaltfläche 
verwenden, um das Audiomaterial auf der zweiten 
der aneinandergrenzenden Spuren eines 
Spurenpaares darzustellen und abzuhören.

View Both Tracks (nur Crossfades). 

Klicken Sie auf diese Schaltfläche, um die 
Wellenformen der ersten beiden benachbarten 
Spuren eines Crossfades mit mehreren 
Spuren darzustellen. 

Fade Curves Only. 

Klicken Sie auf diese Schaltfläche, um die 
Fade-Kurvenform ohne die Wellenform des 
Audiomaterials darzustellen. Dies ist die 
Standarddarstellung, wenn Sie das Fades-
Dialogfeld öffnen.

Fade Curves and Separate Waveforms. 

Klicken Sie auf diese Schaltfläche, um sowohl die 
festgelegten Fade-Kurvenformen als auch separate 
Wellenformdarstellungen der Fade-Ins und Fade-
Outs anzuzeigen.

Fade Curves and Superimposed Waveforms. 

Klicken Sie auf diese Schaltfläche, um die 
festgelegten Fade-Kurvenformen mit integrierter 
Darstellung der Wellenformen der Fade-Ins und 
Fade-Outs anzuzeigen. 

Fade Curves and Summed Waveform. 

Klicken Sie auf diese Schaltfläche, um die 
festgelegten Fade-Kurven mit einer integrierten 
Darstellung der Wellenform des Audiomaterials 
mit Crossfades anzuzeigen.

Zoom In. 

Klicken Sie auf diese Schaltfläche, um die 
Amplitude der Waveform-Darstellung zu 
vergrößern. Klicken Sie bei gedrückter Strg-
Taste (Windows) bzw. Befehlstaste (Mac), 
um zur Standardeinstellung zurückzukehren.

Zoom Out. 

Klicken Sie auf diese Schaltfläche, um die 
Amplitude der Waveform-Darstellung zu 
verkleinern. Klicken Sie bei gedrückter Strg-
Taste (Windows) bzw. Befehlstaste (Mac), 
um zur Standardeinstellung zurückzukehren.
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Einstellungen für die Fade-
Out-Form
Mit der Out Shape-Einstellung können Sie die 
Form des Fade-Outs eines Clips für einen Fade 
oder des Clip 1 für einen Crossfade definieren. 

Standard. – erzeugt eine einseitig gewölbte Fade-
Kurve. Auf diese Weise wird ein vielseitig 
verwendbarer Fade erzeugt, der durch Ziehen der 
Kurve weiter editiert werden kann.

S-Curve. – erzeugt eine S-förmige Kurve, die sich 
am Kurvenanfang und Kurvenende umkehrt. Auf 
diese Weise ist es etwa möglich, Fade-Outs 
schneller beginnen und langsamer auslaufen zu 
lassen. S-förmige Kurven sind nützlich, wenn Sie 
Material verwenden, bei dem das Überblenden 
sehr schwierig ist. Eine Bearbeitung ist durch 
Ziehen der Kurve im Curve Editor möglich.

Preset-Kurven. – stehen zur schnellen Erzeugung 
von Crossfades zur Verfügung (in 7 häufig 
verwendeten Kurvenformen). Diese können durch 
Ziehen der Endpunkte der Kurvenform im Curve 
Editor editiert werden. Im Folgenden werden die 
sieben Preset-Kurvenformen kurz beschrieben:

 Preset-Kurve 1 behält während des Fades die 
Lautstärke bei, am Ende des Fades wird die 
Lautstärke sofort reduziert.

 Bei Preset-Kurve 2 erfolgt der Fade-Out relativ 
langsam, wobei die Lautstärke während des 
gesamten Fades ziemlich hoch bleibt.

 Bei Preset-Kurve 3 erfolgt der Fade-Out etwas 
schneller und die Lautstärke ist während des 
gesamten Fades etwas geringer.

 Bei Preset-Kurve 4 erfolgt der Fade-Out linear. 
Preset-Kurve 4 ist die Standard-Kurvenform.

 Bei Preset-Kurve 5 wird zu Beginn des 
Crossfades schnell ausgeblendet.

 Bei Preset-Kurve 6 wird die Lautstärke zu 
Beginn des Fades noch schneller reduziert.

 Mit Preset-Kurve 7 wird die Lautstärke zu 
Beginn des Fades ausgeschaltet.

Fade-Out-Kurvenform

Preset-Kurve 1

Preset-Kurve 2

Preset-Kurve 3

Preset-Kurve 4

Preset-Kurve 5

Preset-Kurve 6

Preset-Kurve 7
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Link-Optionen
(Nur Crossfades)

Mit den Link-Optionen können Sie die selektierte 
Fade-Out- und Fade-In-Kurvenformen eines 
Crossfades miteinander verknüpfen. Beim 
Anpassen einer Kurve wird auch die andere Kurve 
angepasst. So können Sie erreichen, dass ein 
Crossfade, je nach gewählter Einstellung, mit 
gleichen Energie- (Equal Power) oder 
Lautstärkewerten (Equal Gain) verläuft.

Equal Power. – empfiehlt sich bei nicht 
phasenkohärentem Material, etwa bei Clips 
mit komplett unterschiedlichem Audiomaterial. 
Verwenden Sie diese Option, um einen starken 
Abfall der Lautstärke zu vermeiden, wie er bei 
einem Equal Gain-Crossfade auftreten kann. 
Klicken Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) auf die Fade-Kurve, um diese 
auf die Standardeinstellung zurückzusetzen.

Equal Gain. – empfiehlt sich bei phasenkohärentem 
oder nahezu phasenkohärentem Material, etwa bei 
einem Crossfade zwischen identischen 
Clips/Instrumenten (etwa einem wiederholten 
Drum-Loop). Sie können diese Option verwenden, 
um Übersteuerung (Clipping) zu vermeiden, wie es 
bei Equal Power-Crossfades auftreten kann. 
Klicken Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) auf die Fade-Kurve, um diese 
auf die Standardeinstellung zurückzusetzen.

None. – deaktiviert die Kopplung von Fade-
Out- und Fade-In-Kurven und ermöglicht 
das unabhängige Editieren der Kurvenformen 
einschließlich ihrer Start- und Endpunkte. 
Mit dieser Option können Sie außerdem 
anwenderdefinierte Crossfade-
Formen erzeugen. 

Wenn Link auf Equal Power oder Equal Gain 
festgelegt ist, können Sie den Fade-In-Abschnitt 
der Kurve nur bearbeiten, indem Sie die Alt-Taste 
(Windows) bzw. die Wahltaste (Mac) beim Ziehen 
drücken. Um nur den Fade-Out-Abschnitt einer 
Kurve zu bearbeiten, halten Sie die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac) gedrückt, 
während Sie die Kurvenform ziehen.

Einstellungen für die Fade-
In-Kurvenform
Mit der In Shape-Einstellung können Sie die Form 
des Fade-Ins eines Clips für einen Fade oder des 
Clips 2 für einen Crossfade definieren. 

Standard. – erzeugt eine einseitig gewölbte Fade-
Kurve. Auf diese Weise wird ein vielseitig 
verwendbarer Fade erzeugt, der durch Ziehen der 
Kurve weiter editiert werden kann.

S-Curve. – erzeugt eine S-förmige Kurve, die 
sich am Kurvenanfang und Kurvenende umkehrt. 
Auf diese Weise ist es möglich, Fade-Ins 
schneller beginnen und langsamer auslaufen zu 
lassen. S-förmige Kurven sind nützlich, wenn Sie 
Material verwenden, bei dem das Ausblenden 
Schwierigkeiten bereitet. Eine Bearbeitung ist 
durch Ziehen der Kurve im Curve Editor möglich.

Fade-Link

Ändern des Endpunkts einer Fade-Kurve



Kapitel 28: Fades und Crossfades 631

Preset-Kurven. – stehen zur schnellen Erzeugung 
zur Verfügung (in 7 häufig verwendeten 
Kurvenformen). Diese können durch Ziehen 
der Endpunkte der Kurvenform im Curve Editor 
editiert werden. Im Folgenden werden die sieben 
Preset-Kurvenformen kurz beschrieben:

 Preset-Kurve 1 blendet am Anfang des Fades 
bei voller Lautstärke ein. Diese Lautstärke wird bis 
zum Ende des Fades beibehalten.

 Bei Preset-Kurve 2 wird schnell eingeblendet 
und die volle Lautstärke wird schon sehr 
bald erreicht.

 Preset-Kurve 3 erhöht die Lautstärke in 
mittlerer Geschwindigkeit.

 Bei Preset-Kurve 4 erfolgt der Fade-In linear. 
Preset-Kurve 4 ist die Standard-Kurvenform.

 Bei Preset-Kurve 5 wird zu Beginn des Fades 
langsam eingeblendet.

 Ist Preset-Kurve 6 eingestellt, wird noch 
langsamer als in Preset-Kurve 5 eingeblendet.

 Mit Preset-Kurve 7 wird die Lautstärke bis zum 
Ende des Fades ausgeschaltet.

Typische Kurvenkombinationen
Im Folgenden werden mögliche Kombinationen 
von Kurvenformen aufgeführt.

Linearer Crossfade. – ist ein allgemein gut 
geeigneter Crossfade mit einem weichen und 
gleichmäßigen Übergang zwischen Clip 1 
und Clip 2.

Preset-Kurve 1

Preset-Kurve 2

Preset-Kurve 3

Preset-Kurve 4

Preset-Kurve 5

Preset-Kurve 6

Preset-Kurve 7

Linearer Crossfade

1. Out 2. In
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Equal Power-Crossfade. – ist ein allgemein gut 
geeigneter Crossfade, der sehr nützlich ist, wenn 
ein linearer Crossfade am Berührungspunkt der 
beiden Clips störende Sprünge im 
Lautstärkeverlauf verursachen würde.

Overlap-Fade. – belässt beide Clips während des 
Crossfades auf voller Amplitude: Clip 2 „springt“ 
zu Beginn des Crossfades auf vollen Pegel, der 
Pegel von Clip 1 fällt am Ende des Crossfades auf 
den Wert „Null“ ab.

Voreinstellungen für Fades 
und Crossfades
Sie können bestimmte Voreinstellungen für Fades 
und Crossfades vornehmen. Diese 
Voreinstellungen werden dann als 
Basiseinstellungen geladen, wenn Sie den Create 
Fades-Befehl oder den Fade to Start- bzw. den 
Fade to End-Befehl verwenden.

So legen Sie die Voreinstellungen für Fades und 
Crossfades fest:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Editing-Registerkarte.

2 Stellen Sie die Preview-Pre-Roll- und Preview-
Post-Roll-Werte für die Fade-Vorschau ein.

3 Klicken Sie auf Fade In, legen Sie bei 
Verwendung des Smart-Tools eine Standard-
Kurvenform für Fade-Ins fest und klicken Sie 
dann auf OK.

4 Klicken Sie auf Fade Out, legen Sie bei 
Verwendung des Smart-Tools eine Standard-
Kurvenform für Fade-Outs fest und klicken Sie 
dann auf OK.

5 Klicken Sie auf Crossfade, legen Sie bei 
Verwendung des Smart-Tools eine Standard-
Kurvenform für Crossfades fest und klicken Sie 
dann auf OK.

6 Klicken Sie auf „OK“.

Equal Power-Crossfade

Overlap-Crossfade

1. Out 2. In

1. Out 2. In

Fade-Voreinstellungen

Um die standardmäßige Fade- oder 
Crossfade-Form anzuwenden, nehmen Sie 
eine Edit-Selektion vor und drücken Sie 
Strg + Windows + F (Windows) bzw. 
Befehl + Control + F (Mac).
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Erzeugen von Fades am 
Anfang und Ende von Clips
Mit Pro Tools können Sie am Anfang und am Ende 
von Clips Fade-Ins und Fade-Outs erstellen. 

In Pro Tools HD können Sie darüber hinaus eine 
automatische Fade-In- bzw. Fade-Out-Option 
aktivieren, die es ermöglicht, während der 
Wiedergabe in allen Clips automatisch Fade-Ins 
und Fade-Outs in Echtzeit zu realisieren. Weitere 
Informationen finden Sie unter „Arbeiten mit 
AutoFades“ auf Seite 636.

Erzeugen von Fade-Ins und 
Fade-Outs
Je nachdem, auf welche Art Sie Ihre Selektion 
vornehmen, können Sie Fade-Ins oder Fade-
Outs entweder genau am Anfang oder Ende eines 
Clips positionieren oder sie so einfügen, dass sie 
sich auch über einen leeren Bereich innerhalb 
de Spur erstrecken. Die Länge der Selektion 
innerhalb des Clips bestimmt die Länge des Fade-
Ins oder Fade-Outs.

Sie haben auch die Möglichkeit, einen Fade von 
einem Einfügepunkt zum Anfang oder Ende eines 
Clips zu erstellen.

Obwohl Fades wie eigenständige Clips erscheinen, 
können sie nicht von den Clips, zwischen denen sie 
erzeugt wurden, getrennt werden. 

Bei Tempoänderungen in einer tickbasierten 
Audiospur bleiben Fade-Ins und Fade-Outs in den 
übergeordneten Clips. Die Fades behalten ihre 
absolute Dauer bei und werden folglich nach 
Tempoänderungen neu berechnet.

So erzeugen Sie einen Fade-In:

1 Selektieren Sie den Anfang des Clips, für die 
Sie einen Fade-In erzeugen möchten. Die 
Selektion muss genau bis zum Anfang des Clips 
reichen oder kann außerhalb des Clips in einen 
freien Bereich der Spur hineinragen.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Create. 

• Drücken Sie Strg + F (Windows) bzw. Befehl + 
F (Mac).

3 Wählen Sie die Fade-In-Kurve aus und 
konfigurieren Sie die anderen Fade-
Einstellungen.

4 Klicken Sie auf die Audition-Schaltfläche, 
um den Fade abzuhören.

5 Passen Sie die Kurve an, indem Sie daran 
ziehen oder eine andere Form aus dem In 

Shape-Popup-Menü auswählen.

6 Klicken Sie auf OK. 

Die selektierte Fade-Kurve wird in dem 
Clip dargestellt.

Clip mit einem Fade-In

Selektion des Anfang eines Clips für einen Fade-In

Um einen Fade-In mit der Standardeinstellung 
für Fade-Ins (auf der Editing Preferences-
Registerkarte) anzuwenden, ohne dafür das 
Fades-Dialogfeld zu öffnen, drücken Sie 
Strg + Windows + F (Windows) bzw. Befehl + 
Control + F (Mac).
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So erzeugen Sie einen Fade-Out:

1 Selektieren Sie den Anfang des Clips, für den 
Sie einen Fade-Out erzeugen möchten. Die 
Selektion muss genau bis zum Ende des Clips 
reichen oder kann außerhalb des Clips in einen 
freien Bereich der Spur hineinragen.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Create. 

• Drücken Sie Strg + F (Windows) bzw. Befehl + 
F (Mac).

3 Wählen Sie die Fade-Out-Kurve aus und 
konfigurieren Sie die anderen Fade-
Einstellungen.

4 Klicken Sie auf die Audition-Schaltfläche, 
um den Fade abzuhören.

5 Passen Sie die Kurve an, indem Sie daran 
ziehen oder eine andere Form aus dem Out 

Shape-Popup-Menü auswählen.

6 Klicken Sie auf OK. 

Pro Tools berechnet den Fade und die selektierte 
Fade-Kurve wird in dem Clip dargestellt.

So erzeugen Sie einen Fade vom Einfügepunkt 
zum Startpunkt eines Clips:

1 Platzieren Sie den Cursor an einer Stelle in 
dem Clip.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Fade To Start.

• Drücken Sie Alt + D (Windows) bzw. Control + 
D (Mac).

Der Fade wird entsprechend den Voreinstellungen 
für Fade-Ins erzeugt (siehe „Voreinstellungen für 
Fades und Crossfades“ auf Seite 632).

So erzeugen Sie einen Fade vom Einfügepunkt 
zum Endpunkt eines Clips:

1 Platzieren Sie den Cursor an einer Stelle in 
dem Clip.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Fade To End.

• Drücken Sie Alt + G (Windows) bzw. Control + 
G (Mac).

Der Fade wird entsprechend den Voreinstellungen 
für Fade-Outs erzeugt (siehe „Voreinstellungen für 
Fades und Crossfades“ auf Seite 632).

Selektion des Ende eines Clips für einen Fade-Out

Um den Fade-Out mit der Standardeinstellung 
für Fade-Outs (auf der Editing Preferences-
Registerkarte) anzuwenden, ohne dafür das 
Fades-Dialogfeld zu öffnen, drücken Sie Strg + 
Windows + F (Windows) bzw. Befehl + 
Control + F (Mac).

Die Fade-Länge kann mit den Trim-Tools 
und den Nudge-Trim-Befehlen verändert 
werden. Siehe „Verwenden des Trim-Tools“ 
auf Seite 558 und „Trimmen mit der Nudge-
Funktion“ auf Seite 606.
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Erzeugen eines Crossfades
So erzeugen Sie einen Crossfade zwischen 
zwei Clips:

1 Klicken Sie mit dem Selector-Tool auf die 
gewünschte Anfangsposition des Crossfades in 
Clip 1 und ziehen Sie ihn bis zur gewünschten 
Endposition in Clip 2. Crossfade-Selektionen 
können ihre Start- und Endpunkte an einer 
beliebigen Stelle innerhalb der entsprechenden 
Clips haben.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Create.

• Drücken Sie Strg + F (Windows) bzw. Befehl + 
F (Mac).

3 Verwenden Sie die Schaltflächen zur 
Spurdarstellung, um die Darstellung des 
Crossfades einzustellen. Die Berechnung der 
Wellenformdarstellung kann bei langen 
Selektionen einen Augenblick dauern.

4 Wählen Sie eine Fade-Out-Kurvenform 
(Out Shape) und eine Fade-In-Kurvenform 
(In Shape) aus.

5 Wählen Sie eine Link-Option.

6 Klicken Sie auf die Audition-Schaltfläche, 
um den Crossfade abzuhören. Bei langen 
Crossfades benötigt Pro Tools evtl. einige 
Augenblicke, um den Crossfade zu berechnen 
und das Audiomaterial für die Wiedergabe 
in den Arbeitsspeicher zu laden. 

7 Sie haben folgende Möglichkeiten:

• Ändern Sie die Kurven bei Bedarf mit den 
Voreinstellungen aus dem Out Shape- und dem 
In Shape-Popup-Menü.

• Ziehen Sie die Fade-In- und Fade-Out-Kurven 
in eine anwenderdefinierte Form. Durch 
Aktivierung der Link-Option „None“ können 
Sie die Start- und Endpunkte der Fade-Kurven 
beliebig verändern.

8 Klicken Sie auf die Audition-Schaltfläche, 
um den Crossfade erneut abzuhören.

9 Entspricht der Crossfade Ihren Vorstellungen, 
klicken Sie auf OK. 

Führen Sie einen der folgenden Schritte aus, 
um einen Crossfade zu entfernen:

 Selektieren Sie den Bereich der Spur, in dem 
sich der zu entfernende Crossfade befindet, und 
wählen Sie Edit > Fades > Delete. 

 Wählen Sie den Crossfade mithilfe des 
Time Grabber-Tools aus und drücken Sie 
die Rücktaste (Windows) bzw. die Entf-
Taste (Mac). 

 Klicken Sie mit der rechten Maustaste und mit 
einem der Edit-Tools auf den Crossfade und 
wählen Sie aus dem Popup-Menü Delete Fades. 

So trimmen Sie einen Crossfade:

1 Selektieren Sie den gewünschten Crossfade mit 
dem Time Grabber-Tool oder doppelklicken Sie 
darauf mit dem Selector-Tool.

2 Trimmen Sie mit einem der Trim-Tools 
die Seiten des Crossfades. Der Crossfade 
wird entsprechend der geänderten Länge 
neu berechnet.

Um einen Crossfade mit der 
Standardeinstellung für Crossfades 
(auf der Editing Preferences-Registerkarte) 
anzuwenden, ohne dafür das Fades-
Dialogfeld zu öffnen, drücken Sie Strg + 
Windows + F (Windows) bzw. Befehl + 
Control + F (Mac).

Die Crossfade-Länge kann mit den Trim-
Tools und den Nudge Trim-Befehlen 
verändert werden. Siehe „Verwenden des 
Trim-Tools“ auf Seite 558 und „Trimmen mit 
der Nudge-Funktion“ auf Seite 606.
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Crossfades auf tickbasierten 
Audiospuren
Crossfades werden nach dem Ändern des Tempos 
einer tickbasierten Audiospur neu gerendert. 
Der neue Crossfade hat dieselbe Dauer wie vor 
der Tempoänderung. 

Wenn nicht genug Audiomaterial für einen 
vollständigen Crossfade zur Verfügung steht 
oder wenn der neue Crossfade-Bereich über 
die gültigen Clipgrenzen hinausgeht, wird der 
Crossfade entfernt.

Pre- und Post-Crossfade-
Selektionen
Wenn Sie einen Bereich selektieren, dessen 
Anfang oder Ende genau zwischen zwei Clips 
liegt, können Sie Pre- oder Post-Crossfades 
erzeugen. Verwenden Sie die Tab-Taste, um den 
Einfügepunkt genau am Anfang oder Ende eines 
Clips zu platzieren.

So erzeugen Sie einen Pre- oder Post-Crossfade:

1 Klicken Sie mit dem Selector-Tool auf die Spur 
mit den Clips, zwischen denen Sie einen 
Crossfade erzeugen möchten.

2 Sie haben folgende Möglichkeiten:

• Drücken Sie die Tab-Taste, um zur nächsten 
Clipgrenze zu gelangen. 

• Drücken Sie Strg + Tab (Windows) bzw. Wahl + 
Tab (Mac), um zur vorangehenden Clipgrenze 
zu gelangen.

3 Erweitern Sie die Selektion, indem Sie einen 
der folgenden Schritte ausführen:

• Um Ihre Selektion zu editieren, ziehen Sie bei 
gedrückter Umschalttaste oder drücken Sie 
Umschalt + Tab, um die Selektion bis zur 
nächsten Clipgrenze zu erweitern. 

• Drücken Sie Strg + Umschalt + Tab (Windows) 
bzw. Wahl + Umschalt + Tab (Mac), um die 
Selektion bis zur die vorangehenden Clipgrenze 
zu erweitern.

4 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Create.

• Drücken Sie Strg + F (Windows) bzw. Befehl + 
F (Mac).

5 Wählen Sie einen Fade-Typ und klicken Sie 
auf OK.

Arbeiten mit AutoFades
(Nur Pro Tools HD)

Pro Tools HD kann bei der Wiedergabe 
automatisch Echtzeit-Fade-Ins und -Fade-Outs auf 
alle Clipgrenzen in der Session anwenden. Geben 
Sie die Dauer (0 bis 10 ms) für automatische 
Echtzeit-Fades über die Voreinstellung Auto Clip 

Fade In/Out Length auf der Operation Preferences-
Seite an. Diese Fade-Ins/-Outs werden während 
der Wiedergabe ausgeführt und erscheinen nicht 
im Edit-Fenster.

Die Option für automatische Fade-Ins und Fade-
Outs wirkt sich darüber hinaus auf das Voice 
Borrowing in einer Session aus. Immer dann, wenn 
eine virtuelle Spur mit niedriger Priorität durch 
eine „Lücke“ (stille Passage) auf einer Spur 
derselben Voice mit höherer Wiedergabepriorität 
abgespielt wird, wird für diesen Übergang 
automatisch ein Fade-In/-Out erzeugt.

AutoFades werden nicht während der 
AudioSuite-Verarbeitung angewendet.
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Dies ist besonders in der Postproduktion, etwa bei 
der Aufnahme von Dialogen, hilfreich. So können 
Sie etwa eine Dialogspur und die zugehörige 
Hintergrund-/Raumtonspur einer gemeinsamen 
Voice zuweisen. Dann können Sie bei einer 
AutoFade-Länge von ungefähr 4 ms die 
Übergänge zwischen Dialogpassagen und 
Dialogpausen immer weich überblenden und 
auf diese Weise störende Klick- und 
Knackgeräusche vermeiden.

Wenn Sie automatische Fade-Ins/-Outs 
verwenden, ersparen Sie sich die Mühe, 
für das Editieren die entsprechenden 
Nulllinienschnittpunkte zu finden oder zahlreiche 
Fade-Ins/-Outs nur zu dem Zweck zu erstellen, 
unerwünschte Klick- und Knackgeräusche bei der 
Wiedergabe zu vermeiden. Die Klick- und 
Knackgeräusche sind in den zugrunde liegenden 
Audiodateien jedoch weiterhin vorhanden. 
Folglich treten die Störungen auch dann noch auf, 
wenn mehrere Clips mit dem AudioSuite-
Duplicate-Plug-In oder dem Befehl Export Clips 

As Files (aus der Clipliste) zu einer einzigen Datei 
zusammengefügt werden. Um diese Echtzeit-
AutoFades auf die Festplatte zu schreiben, wählen 
Sie File > Bounce to > Disk.

So stellen Sie die Länge der automatischen Fade-
Ins/-Outs ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte. 

2 Im Feld Clip Auto Fade In/Out Length können 
Sie einen Wert zwischen 0 und 10 ms eingeben. 
Der Wert Null (Standardeinstellung) bedeutet, 
dass keine automatischen Fade-Ins/Outs 
erstellt werden.

3 Klicken Sie auf OK. Der jeweils gewählte 
AutoFade-Wert wird zusammen mit der 
Session gespeichert und automatisch auf 
alle frei stehenden Clipgrenzen angewendet, 
bis Sie ihn ändern.

Erzeugen von Fades und 
Crossfades mit der Batch-
Funktion
Mit der Batch Fades-Funktion können Sie mehrere 
Fades gleichzeitig erzeugen. Führen Sie eine 
Selektion über mehrere Clips durch und 
verwenden Sie den Befehl „Create Fades“, 
um Crossfades für jeden Clipübergang zu 
erzeugen. Wenn Ihre Selektion Clips enthält, 
die bereits Crossfades aufweisen, können Sie 
diese mit dieser Funktion ändern.

So wenden Sie Crossfades auf die Übergänge 
zwischen mehreren Clips an:

1 Klicken Sie mit dem Selector-Tool in den ersten 
Clip, in den Sie einen Crossfade erzeugen 
möchten. Stellen Sie sicher, dass die Selektion 
den gesamten Clip umfasst.

2 Ziehen Sie, um die Selektion bis zum letzten 
Clip zu erweitern, für den ein Crossfade erzeugt 
werden soll. Stellen Sie sicher, dass die 
Selektion den gesamten Clip umfasst.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Fades > Create.

• Drücken Sie Befehl + F (Mac) bzw. Strg + 
F (Windows).

4 Legen Sie im Batch Fades-Dialogfeld fest, 
ob Sie neue Fades (Create New Fades) bzw. 
neue Fade-Ins/-Outs (Create New Fade-Ins & 

Outs) erzeugen oder bestehende Fades ändern 
(Adjust existing Fades) möchten oder ob eine 
Kombination dieser Optionen durchgeführt 
werden soll. 

Selektierte Clips für Batch Fades
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Wenn Sie sich entscheiden, sowohl neue Fades als 
auch neue Fade-Ins und Fade-Outs zu erzeugen, 
wird an jeder Grenze zu einem benachbarten 
ausgewählten Clip ein neuer Crossfade erzeugt. 
Am Beginn des ersten Clips wird ein neuer Fade-
In, am Ende des letzten Clips ein neuer Fade-
Out erzeugt.

5 Wählen Sie die Position, an der die Fades 
erzeugt werden sollen: „Pre-Splice“ (vor dem 
Berührungspunkt), „Centered“ (zentriert) oder 
„Post-Splice“ (nach dem Berührungspunkt, 
siehe „Crossfades und Kurvenverläufe“ auf 
Seite 625). 

6 Geben Sie die gewünschte Crossfade-Länge in 
Millisekunden ein.

7 Klicken Sie auf OK. 

Pro Tools erstellt die Fades für die 
ausgewählten Clips.

Verschieben (mit oder ohne 
Nudge-Funktion) von Fades 
und Crossfades
Fades und Crossfades können mit oder ohne 
Nudge-Funktion in Spuren verschoben werden, 
unabhängig von den beteiligten Clips. Beim 
Verschieben von Fade-Ins oder Fade-Outs mit 
oder ohne Nudge-Funktion wird Audiomaterial 
ein- oder ausgeblendet, während der Fade vom 
Rand eines beteiligten Clips verschoben wird. 
Beim Verschieben von Crossfades mit oder 
ohne Nudge-Funktion ändert sich der 
Überlappungspunkt der beteiligten Clips. 
Das Verschieben von Fades mit oder ohne Nudge-
Funktion wird auch durch die zugrunde liegenden 
Clipgrenzen eingeschränkt.

Verschieben von Fades oder 
Crossfades mit oder ohne 
Nudge-Funktion innerhalb 
von Clips

So verschieben Sie einen Fade oder Crossfade mit 
oder ohne Nudge-Funktion innerhalb der 
beteiligten Clips:

1 Führen Sie einen der folgenden Schritte aus, 
um den Fade oder Crossfade auszuwählen:

• Verwenden Sie das Time Grabber-Tool, 
um den Fade auszuwählen.

• Verwenden Sie das Selector-Tool, um einen 
Bereich auszuwählen, der den Fade enthält.

2 Verschieben Sie den Fade, indem Sie einen der 
folgenden Schritte ausführen:

Batch Fades (Dialogfeld)

Die Fade-Länge kann mit den Trim-Tools 
und den Nudge-Trim-Befehlen verändert 
werden. Siehe „Verwenden des Trim-
Tools“ auf Seite 558 und „Trimmen mit 
der Nudge-Funktion“ auf Seite 606.

Auswählen eines Fades mit dem Time Grabber-Tool
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• Ziehen Sie den Fade mit dem Time Grabber-
Tool an eine neue Position auf der Spur.

• Verschieben Sie den Fade mit der Nudge-
Funktion, indem Sie die Plus- (+) oder Minus-
Taste (–) auf dem Ziffernblock drücken, 
um den Fade auf der Spur nach vorn oder zurück 
zu verschieben.

Verschieben von Clips mit Fades 
oder Crossfades
Wenn Sie eine Clip-Selektion, die einen Fade-In, 
Fade-Out oder Crossfade aufweist, mit oder ohne 
Nudge-Funktion verschieben, wird der Fade mit 
der Selektion verschoben.

So verschieben Sie eine Clip-Selektion mit Fades 
oder Crossfades:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Time Grabber-Tool auf 
einen Clip (oder doppelklicken Sie mit dem 
Selector-Tool), um den Clip zusammen mit dem 
Fade (-In oder -Out) zu selektieren.

• Selektieren Sie mehrere Clips mit Fades und 
Crossfades, die Sie verschieben möchten. 

2 Verschieben Sie die Clip-Selektion, indem Sie 
einen der folgenden Schritte ausführen:

• Ziehen Sie die Clip-Selektion mit dem Grabber-
Tool an eine neue Position auf der Spur.

• Verschieben Sie die Clip-Selektion mit der 
Nudge-Funktion, indem Sie die Plus- (+) oder 
Minus-Taste (–) auf dem Ziffernblock drücken, 
um den Clip auf der Spur nach vorn oder zurück 
zu verschieben.

Verschieben eines Clips neben 
einem Fade-In oder Fade-Out mit 
der Nudge-Funktion
Wenn Sie eine Clip-Selektion neben einem Fade-
In oder Fade-Out mit der Nudge-Funktion 
verschieben, den Fade aber nicht selektieren, wird 
der Fade gedehnt oder gestaucht, damit der Start- 
oder Endpunkt des Fades erhalten bleibt. Das 
Ausmaß der Änderung hängt vom Umfang des 
Audiomaterials außerhalb des Start- oder 
Endpunkts des Fades ab.

So verschieben Sie einen Clip ohne seinen Fade:

1 Selektieren Sie den Clip, aber nicht den Fade.

2 Verschieben Sie den Clip mit der Nudge-
Funktion, indem Sie die Plus- (+) oder Minus-
Taste (–) auf dem Ziffernblock drücken.

Ziehen des Fades mit dem Time Grabber-Tool

Ergebnis des verschobenen Fades

Ziehen eines Clips mit seinem Fade

Selektion eines Clips ohne seinen Fade

Verschieben eines Clips mit der Nudge-Funktion ohne 
seinen Clip
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Verschieben von Clips neben 
Crossfades
Wenn Sie einen der an einem Crossfade beteiligten 
Clips verschieben, werden die Clips getrennt. 
Der Status des Fades hängt von der Voreinstellung 
„Preserve Fades when Editing“ (auf der Editing 
Preferences-Registerkarte) ab. 

So trennen Sie durch Crossfades verbundene 
Clips und behalten die entsprechenden Fades bei:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Editing-Registerkarte.

2 Aktivieren Sie Preserve Fades when Editing.

3 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

4 Verwenden Sie das Time Grabber- oder 
Separation Grabber-Tool, um einen der Clips zu 
selektieren, die zu einem Crossfade gehören.

5 Ziehen Sie den selektierten Clip mit dem 
Grabber-Tool.

So trennen Sie durch Crossfades verbundene 
Clips und entfernen den Fade:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Editing-Registerkarte.

2 Deaktivieren Sie Preserve Fades when Editing.

3 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen.

4 Verwenden Sie das Time Grabber- oder 
Separation Grabber-Tool, um einen der Clips zu 
selektieren, die zu einem Crossfade gehören.

5 Ziehen Sie den selektierten Clip mit dem 
Grabber-Tool.

Selektieren eines Clips mit einem Crossfade

Trennen von Clips unter Beibehaltung der Fades

Selektieren eines Clips mit einem Crossfade

Trennen von Clips mit Entfernung der Fades
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Verschieben von Clips neben 
Crossfades mit der Nudge-
Funktion
Wenn Sie einen der an einem Crossfade beteiligten 
Clips mit der Nudge-Funktion verschieben, wird 
der Fade gedehnt, damit die relative Position der 
Start- und Endpunkte des Crossfades erhalten 
bleibt. Das Ausmaß der Dehnung hängt davon ab, 
wie sehr die beteiligten Clips überlappen. 

Wenn Sie einen Clip über die Grenze des 
verfügbaren Audiomaterials für den Crossfade 
mit der Nudge-Funktion verschieben, wird der 
Fade entfernt.

So verschieben Sie einen Clip mit der Nudge-
Funktion und dehnen den Crossfade:

1 Selektieren Sie mit dem Time Grabber-Tool 
einen der am Crossfade beteiligten Clips.

2 Verschieben Sie den Clip mit der Nudge-
Funktion, indem Sie die Plus- (+) oder Minus-
Taste (–) auf dem Ziffernblock drücken.

Trennen von Clips mit Fades 
oder Crossfades
Sie können Clips aus Spurmaterial erstellen, 
das mit Fades oder Crossfades überlappt. Wenn 
auf der Editing Preferences-Registerkarte die 
Option Preserve Fades when Editing aktiviert ist, 
werden die Fades aus dem Quellclip an den neuen 
Clip angepasst.

So trennen Sie einen Clip, der mit einem Fade oder 
Crossfade überlappt:

1 Ziehen Sie mit dem Selector-Tool, um das 
Material für den neuen Clip zu selektieren.

2 Wählen Sie Edit > Separate Clip > At Selection.

An Stellen, an denen die Selektion mit Fade-Ins 
oder Fade-Outs überlappt, wird der Fade an die 
Selektion angepasst.

Selektieren eines Clips mit einem Crossfade

Dehnen des Crossfades durch Verschieben mit der 
Nudge-Funktion

Selektieren von Material, das mit einem Fade-
in überlappt

Ergebnis des Separate Clip-Befehls für einen Fade-In



Pro Tools-Referenzhandbuch642

An Stellen, an denen die Selektion mit einem 
Crossfade überlappt, wird der Crossfade an der 
Selektionsgrenze in einen Fade-Out und einen 
Fade-In getrennt.

Trimmen von Clips mit Fades 
oder Crossfades
Sie können Clips trimmen, die Fades oder 
Crossfades enthalten.

Trimmen eines Clips an einer 
Fade-Grenze
Sie können Clips trimmen, die an Fade- und 
Crossfade-Grenzen angrenzen. 

So trimmen Sie einen Clip an einer Fade-Grenze:

 Klicken Sie mit dem Trim-Tool auf die 
Clipgrenze und ziehen Sie, um den Clip zu 
trimmen. Der Fade bleibt konstant und folgt der 
neuen Clipgrenze.

Trimmen an einer Selektion mit 
Fades oder Crossfades
Sie können Clips an Selektionen trimmen, die 
Fades oder Crossfades enthalten.

Führen Sie einen der folgenden Schritte aus, um 
einen Clip an einer Selektion zu trimmen, die 
Fades enthält:

 Nehmen Sie in der Spur eine Selektion vor und 
wählen Sie Edit > Trim > To Selection. Sie 
können den Trim-Befehl über mehrere Clips 
und Fades ausführen. Betroffene Fades werden 
an die neuen Clipgrenzen angepasst.

Auswählen von Material, das mit einem Crossfade 
überlappt

Ergebnis des Separate Clip-Befehls für einen Crossfade

Wenn die Option „Preserve Fades when 
Editing“ in den Editing-Voreinstellungen 
nicht aktiviert ist, werden alle Fades in der 
Selektion bei der Bearbeitung gelöscht.

Ziehen einer Clipgrenze mit dem Trim-Tool 

Ergebnis des Trimmens des Clips
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 Klicken Sie mit dem Selector-Tool in den Clip 
und wählen Sie Edit > Trim > Start to Insertion 
oder End to Insertion. Sie können den Trim-
Befehl an einer Clip- oder Fade-Grenze in der 
Spur ausführen.

Darstellen von Fade-Grenzen 
und -Formen in der 
Automation-Darstellung
Fade-Grenzen und Fade-Formen werden in 
Automation-Darstellungen angezeigt und können 
in diesen Darstellungen auch bearbeitet werden. 
Dadurch ist eine präzisere Anzeige und 
Bearbeitung der Automationsdaten möglich. 
Weitere Informationen zur Automation und zu 
Automation-Darstellungen finden Sie unter 
Kapitel 45: „Automation“.

Trimmen einer Selektion über mehrere Fades

Fade-Informationen in der Automation-Darstellung
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Kapitel 29: Playlists

Das Erstellen von Playlists ist eine leistungsfähige 
Funktion von Pro Tools. Jede Spur enthält eine 
„Haupt-Playlist“ und beliebig viele „alternative“ 
Edit-Playlists.

Mithilfe von Edit-Playlists können Sie von der 
aktuellen Anordnung der Clips in einer Spur 
einen „Schnappschuss“ machen. Sie haben damit 
die Möglichkeit, mit verschiedenen Anordnungen 
zu experimentieren und bei Bedarf zu vorher 
gespeicherten Playlists zurückzukehren.

Eine Playlist, die aus einem oder mehreren Clips 
besteht, kann einer Spur nur dann zugewiesen 
werden, wenn er nicht auf einer anderen Spur in 
Gebrauch ist. Sie können eine fast unbegrenzte 
Anzahl von Edit-Playlists erstellen, die von allen 
Spuren gemeinsam genutzt werden. Jede einzelne 
Spur hat jedoch eine eigene Automation Playlist.

In Automation Playlists für Audio-, Auxiliary-
Eingangs-, Master-Fader- und Instrumentenspuren 
sind Steuerelemente für Lautstärke, 
Pan, Stummschaltung und Plug-Ins 
gespeichert. In Automation Playlists für MIDI-
Spuren befinden sich dagegen nur 
Stummschaltungsdaten. Continuous Controller-
Events, Program Changes und Sysex-Events 
werden in MIDI-Clips gespeichert und befinden 
sich aus diesem Grund in den Edit-Playlists für 
MIDI- und Instrumentenspuren (siehe Kapitel 45: 
„Automation“).

Arbeiten mit Playlists
Eine neu erstellte Spur enthält eine einzelne leere 
Playlist, bis Sie Material aufzeichnen, importieren 
oder mithilfe von Drag & Drop in die Playlist 
aufnehmen.

Neue Playlists können entweder leer oder als 
Duplikate der aktuellen Playlist erstellt werden. 
Nach dem Erstellen der Playlists können Sie diese 
nach Bedarf mit dem Playlist-Selektor aufrufen, 
umbenennen und löschen.

Neue und duplizierte Playlists werden automatisch 
mit dem Spurnamen, gefolgt von einem Punkt (.) 
und der Playlist-Nummer, benannt. Beispielsweise 
wird die erste duplizierte Playlist auf einer Spur 
namens „Kick“ automatisch mit „Kick.01“ 
benannt, nachfolgende duplizierte Playlists 
werden automatisch mit „Kick.02“, „Kick.03“ 
usw. benannt.

Audiomaterial kann aus der Clipliste, aus 
Workspace-Browsern, dem Windows-
Explorer oder dem Mac Finder gezogen und 
in einer Spur abgelegt werden.

Playlist-Selektor



Pro Tools-Referenzhandbuch646

Erstellen einer Playlist
Sie können neue leere Playlists für das Aufnehmen 
oder das Importieren von Audio- und MIDI-
Material erstellen. Dies kann beim Erstellen 
alternativer Takes von Audio- oder MIDI-
Materialien oder beim Entwerfen alternativer 
Arrangements nützlich sein.

So erstellen Sie eine neue (leere) Playlist:

1 Klicken Sie auf den Playlist-Selektor der Spur 
und wählen Sie New.

2 Geben Sie einen Namen für die neue Playlist ein 
und klicken Sie auf OK. 

Eine leere Playlist mit dem von Ihnen 
eingegebenen Namen erscheint auf der Spur.

Duplizieren von Playlists
Wenn Sie eine Spur editieren, können Sie mit 
einer Kopie der Playlist dieser Spur arbeiten. 
Auf diese Weise bleibt die ursprüngliche 
Playlist unverändert.

So duplizieren Sie die aktuelle Playlist einer Spur:

1 Klicken Sie auf den Playlist-Selektor der Spur 
und wählen Sie aus dem Popup-Menü die 
Option Duplicate.

2 Geben Sie einen Namen für die neue Playlist 
ein und klicken Sie auf OK. 

Die duplizierte Playlist wird auf der Spur 
angezeigt, der Name der Spur entspricht jetzt 
dem Namen der neuen Playlist.

Zuweisen einer Playlist zu einer 
anderen Spur
Standardmäßig ist eine Playlist nur für die Spur 
verfügbar, auf der sie erstellt wurde. Wird die 
Playlist jedoch in der ursprünglichen Spur oder 
einer anderen Spur nicht mehr genutzt, kann sie 
mit der Other Playlists-Funktion in einer anderen 
Spur neu zugewiesen werden. Wenn eine Playlist 
einer anderen Spur neu zugewiesen wird 
(einer beliebigen Spur zugewiesen), steht sie 
anderen Spuren, einschließlich ihrer 
ursprünglichen Spur, nicht mehr zur Verfügung.

Die Zeitbasis einer Audio-Playlist wird zusammen 
mit der Playlist gespeichert. Beim Zuweisen einer 
nicht zugewiesenen Playlist zu einer beliebigen 
Spur nimmt die Spur die gespeicherte Zeitbasis der 
Playlist an.

So weisen Sie eine Spur-Playlist zu:

 Klicken Sie auf den Playlist-Selektor der 
Spur und führen Sie eine der folgenden 
Aktionen aus:

• Wählen Sie eine Playlist der Spur aus.

• Wählen Sie eine Playlist von einer anderen Spur 
aus, indem Sie auf das Other Playlist-
Untermenü klicken und eine Playlist auswählen.

Die selektierte Playlist wird auf der Spur 
angezeigt, der Name der Spur entspricht jetzt dem 
der selektierten Playlist.

Drücken Sie Ctrl + \ (Mac) bzw. Windows + \ 
(Windows), um eine neue Playlist für die erste 
selektierte Spur in der Session zu erstellen.

Drücken Sie Befehl + Ctrl + \ (Mac) bzw. 
Strg + Windows + \ (Windows), um die Haupt-
Playlist für die erste selektierte Spur in der 
Session zu duplizieren.

Selektieren einer Playlist von einer anderen Spur
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Umbenennen einer Playlist
Sie können eine Playlist umbenennen, indem 
Sie den Namen der Spur ändern, der sie 
zugewiesen ist. 

So benennen Sie die Playlist einer Spur um:

1 Doppelklicken Sie auf den Namen der Spur.

2 Geben Sie einen neuen Namen ein und klicken 
Sie auf OK. 

Die Namen von Spur und Playlist 
werden aktualisiert.

Löschen einer Playlist
Sie können eine Playlist komplett aus einer 
Session löschen. Da Playlists nur minimalen 
Speicherplatz benötigen, müssen Sie sie nicht 
löschen, um Speicherplatz zu sparen.

So löschen Sie eine oder mehrere Playlists aus 
einer Spur:

1 Klicken Sie auf den Playlist-Selektor der Spur 
und wählen Sie Delete Unused.

2 Wählen Sie die nicht zugewiesenen Playlists, 
die Sie löschen möchten. Klicken Sie bei 
gedrückter Umschalttaste (Windows oder Mac), 
bei gedrückter Strg-Taste (Windows) bzw. bei 
gedrückter Befehlstaste (Mac), um mehrere 
Playlists zu selektieren.

3 Klicken Sie auf OK, um die selektierten 
Playlists zu löschen. Dieser Vorgang kann nicht 
wieder rückgängig gemacht werden.

Playlists und Edit-Gruppen
Durch das Erstellen neuer Playlists mit gruppierten 
Spuren werden die Suffixe der Playlist-Namen 
automatisch für jede Spur der aktiven Edit-Gruppe 
erhöht. Dadurch können Sie zu einem früheren 
Take zurückkehren, indem Sie die Playlist-Takes 
nach Gruppe wechseln. 

Mithilfe dieser Methode können Sie neue Spuren 
zur vorhandenen Gruppe hinzufügen. Die Suffixe 
für die Playlist-Namen bleiben dabei mit den 
ursprünglichen Spuren synchron. 

Es werden automatisch „leere“ Playlists erstellt, 
damit die Playlist-Takes beim Zurückwechseln zu 
den frühesten Playlist-Takes in der Gruppe 
synchron bleiben.

So halten Sie die Namen und Änderungen von 
Playlists synchron (Beispielarbeitsablauf):

1 Erstellen Sie neue Spuren und gruppieren 
Sie sie.

2 Stellen Sie sicher, dass die Gruppe aktiviert ist.

3 Erstellen Sie eine neue Playlist. Klicken Sie 
dazu auf den Playlist-Selektor in einer der 
Spuren der Gruppe, und wählen Sie „New“. Das 
Standard-Suffix ist jetzt „.01“, womit Take 1 
angegeben wird.

4 Nehmen Sie Take 1 auf und erstellen Sie dann 
eine neue Playlist. Die Playlists auf allen 
Spuren in der Gruppe werden auf „.02“ erhöht.

5 Erstellen Sie neue Spuren (beispielsweise für 
einen zusätzlichen Musiker oder ein 
zusätzliches Mikrofon) und fügen Sie diese zur 
Gruppe hinzu, oder erstellen Sie eine neue 
Gruppe mit allen Spuren.

6 Erhöhen Sie alle Playlists. Klicken Sie dazu auf 
den Playlist-Selektor in einer der Spuren der 
Gruppe und wählen Sie New.

Sie können Playlists auch in der Playlists-
Darstellung löschen. Klicken Sie mit der 
rechten Maustaste auf den Playlist-Namen in 
einer Lane oder in der Tracks-Liste und 
wählen Sie „Delete“.

Wenn Sie eine Spur aus einer Session 
löschen, können Sie dazugehörige 
Playlists entweder löschen oder für 
andere Spuren verwenden.

Weitere Informationen zum Gruppieren von 
Spuren finden Sie unter „Gruppieren von 
Spuren“ auf Seite 255.
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Alle Playlists weisen jetzt das gleiche angehängte 
Suffix auf. (Das Erstellen zusätzlicher Playlists in 
beliebigen Spuren der Gruppe erhöht deren 
Playlists, um sie synchron zu halten.)

7 Wenn Sie sich den .01-Take auf der ersten 
Gruppe der Spuren anhören möchten, können 
Sie jede Playlist in der Gruppe zurück auf 
Playlist .01 ändern.

Alle Spuren in der Gruppe haben Playlists mit 
„.01“-Suffixen. Das gilt auch für solche Spuren, 
die nach den früheren Takes zur Original-Gruppe 
hinzugefügt wurden. Auf diesen neu 
hinzugefügten Elementen werden automatisch 
leere Playlists erstellt, sodass die Playlist-
Nummern für alle Elemente der Gruppe 
übereinstimmen. 

Elastic Audio und 
alternative Playlists
Nur Tempoänderungen haben Auswirkungen 
auf alternative Playlists in Elastic Audio-
fähigen, tickbasierten Spuren. Ansonsten werden 
alternative Playlists nicht durch die Bearbeitung 
von Warp- oder Event-Markern in der Haupt-
Playlist beeinflusst.

Spur-Compositing
Pro Tools bietet Spur-Compositing-Tools für 
Audiospuren. Beim Spur-Compositing handelt 
es sich um den Prozess einer Zusammenführung 
diverser alternativer Takes oder Playlists mit 
dem Ziel, die bestmögliche Version aus mehreren 
Aufnahmedurchgängen zu erzeugen. Mit der 
Playlists-Darstellung für eine Audiospur können 
Sie die besten Stücke aus den alternativen Playlists 
der Spur auswählen und sie in die Haupt-Playlist 
kopieren. Hiermit erstellen Sie schnell und einfach 
den „perfekten Take“ aus mehreren alternativen 
Playlists.

Beispiel zum Spur-Compositing
In diesem Workflow werden Sie in einige der 
grundlegenden Aufgaben beim Spur-Compositing 
eingeführt:

• Konfigurieren einer Session für diesen 
Workflow

• Loop-Aufnahme mehrerer Takes auf einer 
Audiospur

• Abhören und Auswählen des besten Takes

• Kopieren des besten Takes in die Haupt-Playlist

So konfigurieren Sie eine Session:

1 Öffnen Sie eine bestehende Pro Tools-Session 
oder erstellen Sie eine neue.

2 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

3 Wählen Sie im Record-Bereich der Operation-
Registerkarte die Option Automatically Create 

New Playlists When Loop Recording.

4 Klicken Sie auf OK.
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So erstellen Sie eine Loop-Aufnahme 
mehrerer Takes:

1 Erstellen Sie eine neue Audiospur 
(Stereo oder Mono) oder verwenden Sie 
eine bestehende Spur.

2 Stellen Sie sicher, dass die Quelle, von der 
Sie aufnehmen möchten, ordnungsgemäß 
angeschlossen und auf den Spureneingang 
geroutet ist.

3 Wählen Sie im Track View-Selektor Playlists. 

4 Um Spurmaterial bis zum Startpunkt des Loops 
abhören zu können, aktivieren Sie die Pre-Roll-
Funktion und legen Sie die Pre-Roll-Zeit fest.

5 Führen Sie einen der folgenden Schritte aus, 
um die Loop-Aufnahme zu aktivieren:

• Aktivieren Sie Options > Loop Playback.

• Klicken Sie mit der rechten Maustaste auf die 
Wiedergabeschaltfläche im Transport-Fenster 
und wählen Sie Loop.

6 Vergewissern Sie sich, dass Options > Link 

Timeline and Edit Selection aktiviert ist.

7 Selektieren Sie mit dem Selector-Tool den 
Loop-Bereich auf der Spur. 

8 Schalten Sie die Audiospur scharf, indem Sie 
auf die entsprechende Record Enable-
Schaltfläche klicken.

9 Klicken Sie im Transport-Fenster auf „Record“, 
um Pro Tools für die Aufnahme 
scharfzuschalten.

10 Klicken Sie auf „Play“, um die Aufnahme 
zu starten.

11 Klicken Sie abschließend auf „Stop“, 
um die Aufnahme anzuhalten.

12 Wenn Sie keinen weiteren Durchgang für die 
Loop-Aufnahme starten möchten, deaktivieren 
Sie die Aufnahme für die Audiospur.

Beachten Sie, dass nach dem Beenden der 
Aufnahme alle Takes der Loop-Aufnahme in 
Playlist-Lanes unterhalb der Haupt-Playlist 
angezeigt werden (inklusive des gesamten 
Audiodatei-Clips sämtlicher Loop-
Aufnahmedurchgänge).

Playlists-Darstellung mit mehreren alternativen 
Playlists

Wenn die Option „Automatically Create New 
Playlists When Loop Recording“ vor dem 
Start der Loop-Aufnahme deaktiviert war, 
klicken Sie mit der rechten Maustaste auf den 
Clip in der Haupt-Playlist und wählen Sie 
„Matches > Expand Alternates to New 
Playlists“.



Pro Tools-Referenzhandbuch650

Um die Playlist für den gesamten Datei-Clip 
auszublenden, führen Sie einen der folgenden 
Schritte aus:

 Klicken Sie mit der rechten Maustaste auf die 
Playlist-Lane und wählen Sie Hide.

 Behalten Sie dieselbe Edit-Selektion bei, die 
Sie für die Loop-Aufnahme verwendet haben, 
und klicken Sie mit der rechten Maustaste auf 
den Spurnamen oder einen der Namen der 
Playlist-Lanes und wählen Sie Filter Lanes > 

Show Only Lanes With > Clips Within the Edit 

Selection.

So hören Sie alternative Playlists ab:

1 Führen Sie einen der folgenden Schritte aus, 
um die Loop-Wiedergabe zu aktivieren:

• Aktivieren Sie Options > Loop Playback.

• Klicken Sie mit der rechten Maustaste auf die 
Wiedergabeschaltfläche im Transport-Fenster 
und wählen Sie Loop.

2 Starten Sie mit intakter Timeline-Selektion die 
Wiedergabe, während sämtliche Pre-/Post-Roll-
Einstellungen aktiviert sind. Die Haupt-Playlist 
wird wiedergegeben.

3 Klicken Sie auf die Solo-Schaltfläche für die 
Lane der alternativen Playlist, die Sie abhören 
möchten. Wiederholen Sie diesen Schritt für 
jede Playlist-Lane. (Beim Soloschalten einer 
Playlist-Lane wird nur die Playlist in der Spur 
sologeschaltet; andere Spuren aus der Session 
werden nicht stummgeschaltet.)

So selektieren Sie den besten Take und kopieren 
ihn in die Haupt-Playlist:

1 Wenn Sie den besten Take gefunden haben, 
nehmen Sie ggf. Änderungen an der Edit-
Selektion vor. Diese Selektion wird dann in die 
Haupt-Playlist kopiert.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Copy Selection To > 

Main Playlist.

• Klicken Sie mit der rechten Maustaste auf die 
Selektion und wählen Sie Copy Selection to 

Main Playlist.

• Klicken Sie auf die Schaltfläche „Copy 
Selection to Main Playlist“ der betreffenden 
Playlist-Lane.

Filtern angezeigter Playlist-Lanes

Kopieren der Edit-Selektion einer alternativen Playlist 
in die Haupt-Playlist.

Drücken Sie Strg + Alt + Windows + V 
(Windows) bzw. Wahl + Ctrl + V 
(Mac), um die Selektion in die Haupt-
Playlist zu kopieren.

Schaltfläche „Copy Selection 
to Main Playlist“
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Playlists-Darstellung
In der Playlists-Darstellung können Sie die Haupt-
Playlist der Spur sowie alle alternativen Playlists, 
die mit der Spur verbunden sind, anzeigen. 
Alternative Playlists werden direkt unterhalb 
der Spur in Playlist-Lanes angezeigt.

Sie können alternative Playlists in der Playlists-
Darstellung genau wie die Haupt-Playlist in 
der Waveform-Darstellung bearbeiten. In der 
Playlists-Darstellung werden Änderungen an 
Selektionen auf alle eingeblendeten alternativen 
Playlists angewandt. Alternative Playlists, 
die nicht eingeblendet sind, sind davon 
nicht betroffen.

So zeigen Sie die Playlist-Lanes für eine Spur an:

 Wählen Sie im Track View-Selektor Playlists.

\

Wenn die Spur keine alternativen Playlists 
zusätzlich zur Haupt-Playlist enthält, wird nur eine 
einzelne, leere Playlist-Lane unterhalb der Haupt-
Playlist angezeigt. Sie können Audiomaterial aus 
der Clipliste, Workspace-Browsern oder anderen 
Audiospuren auf diese Lane ziehen, um eine 
alternative Playlist für die Spur zusätzlich zur 
Haupt-Playlist zu erstellen.

Wenn die Spur eine oder mehrere alternative 
Playlists zusätzlich zur Haupt-Playlist enthält, 
werden diese in Lanes unterhalb der Haupt-
Playlist angezeigt. Dessen ungeachtet ist die 
unterste Playlist-Lane immer leer und kann zum 
Hinzufügen weiterer Clips zur Erstellung 
alternativer Playlists verwendet werden.

Bevor Sie mit dem Spur-Compositing 
beginnen, sollten Sie die Haupt-Playlist der 
Spur duplizieren, um sie als alternative 
Backup-Playlist zur Verfügung zu halten.

Clipgruppen werden in der Playlists-
Darstellung für Spuren nicht unterstützt.

Auswählen der Playlists-Darstellung

Drücken Sie Strg + Alt (Windows) bzw. 
Befehl + Ctrl (Mac) und klicken Sie auf 
den Playlist-Selektor, um zwischen Playlists-
Darstellung und Waveform-Darstellung 
zu wechseln.

Ziehen von Audiomaterial aus der Clipliste, um eine 
alternative Playlist zu erstellen

Spur mit alternativen Playlists in der Playlists-
Darstellung
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Abhören alternativer Playlists
Nur die Haupt-Playlist wird über den Audio-
Ausgabepfad der Spur wiedergegeben. Um eine 
alternative Playlist abzuhören, müssen Sie die 
Playlist-Lane soloschalten. Die sologeschaltetete 
Lane wird dann über den Audio-Ausgabepfad der 
Spur anstelle der Haupt-Playlist wiedergegeben.

So hören Sie eine alternative Playlist ab:

1 Klicken Sie auf die Solo-Schaltfläche für 
die Playlist-Lane, die Sie abhören möchten. 
(Beim Soloschalten einer Playlist-Lane wird 
nur die Playlist in der Spur sologeschaltet; 
andere Spuren aus der Session werden 
nicht stummgeschaltet.)

2 Starten Sie die Wiedergabe in Pro Tools.

Kopieren alternativer Playlists 
in die Haupt-Playlist
Wenn Sie eine Selektion in einer alternativen 
Playlist gefunden haben, die Sie in der Haupt-
Playlist verwenden möchten, kopieren Sie die 
Selektion und fügen Sie sie in der Haupt-Playlist 
ein. Auf diese Weise können Sie die verschiedenen 
alternativen Playlists optimal kombinieren. 

Zusätzlich zum manuellen Kopieren und Einfügen 
in die Haupt-Playlist bietet Pro Tools verschiedene 
Befehle zum Kopieren und Einfügen einer 
Selektion in der Haupt-Playlist:

Copy Selection To Main Playlist. – kopiert die 
Selektion und fügt sie in der Haupt-Playlist ein. 
Sämtliches Material, das sich in der Haupt-Playlist 
bereits an derselben Position befindet, 
wird überschrieben.

Auswahl in neue Playlist kopieren. – erstellt eine 
neue, leere Haupt-Playlist und fügt die Selektion 
darin ein.

Auswahl in Playlist-Duplikat kopieren. – 
dupliziert die aktuelle Haupt-Playlist und fügt die 
Selektion im Duplikat ein. Die vorherige Haupt-
Playlist wird in eine neue Playlist-Lane verschoben.

So kopieren Sie eine Selektion aus einer 
alternativen Playlist in die Haupt-Playlist:

1 Treffen Sie in der Playlists-Darstellung eine 
Selektion in einer alternativen Playlist.Soloschalten einer alternativen Playlist

Drücken Sie Umschalt + S, um eine beliebige 
Playlist-Lane, in der sich der Edit-Cursor 
befindet, solozuschalten. Wenn sich der Edit-
Cursor in mehreren Playlist-Lanes befindet, 
wird die oberste Lane sologeschaltet.

Verwenden Sie Windows + P und Windows + ; 
(Windows) bzw. Ctrl + P und Ctrl + ; (Mac), 
um den Edit-Cursor durch die Playlist-Lanes 
nach oben oder unten zu bewegen.

Treffen einer Selektion in einer alternativen Playlist
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2 Sie haben folgende Möglichkeiten:

• Klicken Sie bei den Steuerelementen der 
Playlist-Lane auf die Schaltfläche „Copy 
Selection to Main Playlist“.

• Wählen Sie Edit > Copy Selection to 

Main Playlist.

• Klicken Sie mit der rechten Maustaste auf die 
Selektion und wählen Sie Copy Selection to 

Main Playlist.

Die Selektion aus der alternativen Playlist wird an 
dieselbe Zeitposition in der Haupt-Playlist kopiert.

So kopieren Sie eine Selektion aus einer 
alternativen Playlist in eine neue Haupt-Playlist:

1 Treffen Sie in der Playlists-Darstellung eine 
Selektion in einer alternativen Playlist.

2 Wählen Sie Edit > Copy Selection to 

New Playlist.

So kopieren Sie eine Selektion aus einer 
alternativen Playlist in eine duplizierte 
Haupt-Playlist:

1 Treffen Sie in der Playlists-Darstellung eine 
Selektion in einer alternativen Playlist.

2 Wählen Sie Edit > Copy Selection to 

Duplicate Playlist.

Drücken Sie Strg + Alt + Windows + 
V (Windows) bzw. Wahl + Ctrl + V (Mac), 
um die Selektion in die Haupt-Playlist 
zu kopieren.

In die Haupt-Playlist kopierte Selektion

In eine neue Haupt-Playlist kopierte Selektion

In eine duplizierte Haupt-Playlist kopierte Selektion



Pro Tools-Referenzhandbuch654

Ziehen von Clips in 
Playlist-Lanes
Sie können Clips in jede verfügbare Playlist-Lane 
auf jeder Spur mit derselben Kanalanzahl ziehen 
und dort ablegen. Sie können also beispielsweise 
keinen Stereo-Clip in die Playlist-Lane einer 
Monospur ziehen und dort ablegen. Auf ähnliche 
Weise können Sie Clips von einer beliebigen 
Playlist-Lane in eine beliebige andere Spur mit 
derselben Kanalanzahl ziehen.

Bearbeitung in Playlist-Lanes
Sie können Clips in Playlist-Lanes auf dieselbe 
Weise wie in der Haupt-Playlist bearbeiten. 
Sie können sogar Clips zwischen verschiedenen 
Playlist-Lanes (inklusive der Haupt-Playlist), 
zwischen verschiedenen Spuren und verschiedenen 
Zeitpunkten verschieben. Allerdings können Sie 
Ihre Bearbeitungen an den Playlist-Lanes erst 
abhören, wenn die Lane, die Sie bearbeiten, 
sologeschaltet ist (siehe „Abhören alternativer 
Playlists“ auf Seite 652).

Neuanordnen von Playlist-Lanes
Sie können Playlist-Lanes auf dieselbe Art wie 
Spuren neu anordnen.

So ordnen Sie Playlist-Lanes neu an:

 Klicken Sie auf den Namen der alternativen 
Playlist und ziehen Sie ihn an die gewünschte 
Position.

Ändern der Größe von 
Playlist-Lanes
Sie können die Größe von Playlist-Lanes auf 
dieselbe Art wie bei Spuren ändern. 

So ändern Sie die Größe der Spur und aller 
Playlist-Lanes zusammen:

 Klicken Sie auf die Linie zwischen den Lanes 
und ziehen Sie sie nach oben oder unten. 
Die Spur und alle Playlist-Lanes erhalten 
entsprechend eine neue Größe.

 Klicken Sie mit der rechten Maustaste auf die 
vertikale Skala zwischen dem Playlist-Bereich 
und den Steuerelementen für die Playlist-Lane 
und wählen Sie die gewünschte Lane-Größe 
aus. Die Spur und alle Playlist-Lanes erhalten 
entsprechend eine neue Größe.

Neuanordnen von Playlist-Lanes

Mit den Tastenkombinationen Windows + 
Pfeil nach oben/unten (Windows) bzw. Ctrl- + 
Pfeil nach oben/unten (Mac) können Sie die 
Höhen der Spuren, Playlists und Lanes, die 
den Edit-Cursor oder eine Edit-Selektion 
enthalten, anpassen.
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So ändern Sie die Größe einer einzelnen 
Playlist-Lane:

 Klicken Sie bei gedrückter Strg- oder Ctrl-Taste 
auf die Linie zwischen den Lanes und ziehen 
Sie sie nach oben oder unten. Die Größe der 
oberen Lane wird entsprechend geändert.

 Halten Sie die Strg- oder Ctrl-Taste gedrückt 
und klicken Sie mit der rechten Maustaste auf 
die vertikale Skala zwischen dem Playlist-
Bereich und den Steuerelementen für die 
Playlist-Lane und wählen Sie die gewünschte 
Lane-Größe aus.

Umbenennen alternativer 
Playlists
Sie können alternative Playlists auf dieselbe Art 
wie Spuren umbenennen. 

So benennen Sie eine alternative Playlist um:

1 Doppelklicken Sie auf den Namen der 
alternativen Playlist.

2 Geben Sie im Dialogfeld „Name“ den 
gewünschten Namen ein.

3 Klicken Sie auf OK.

Alternative Playlists in der 
Tracks-Liste
Wenn eine Audiospur auf die Playlists-Darstellung 
eingestellt ist, werden alle dazugehörigen Playlists 
in der Tracks-Liste unterhalb des Spurnamens 
aufgeführt. Die Namen dazugehöriger alternativer 
Playlists werden eingerückt dargestellt, um die 
Playlist-Lanes von Spuren zu unterscheiden. Über 
die Tracks-Liste können Sie alternative Playlists 
ein- und ausblenden. Sie können auch auf das 
Rechtsklick-Menü für alternative Playlists 
zugreifen. Hier stehen Ihnen die Befehle Show, 
Hide, Scroll Into View, Rename, Delete und Filter 

Lanes zur Verfügung.

Ändern der Größe einer Playlist-Lane

Auswählen einer voreingestellten Größe für eine 
Playlist-Lane

Tracks-Liste mit Playlist-Lanes für die Spur „Audio 1“
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Filtern von Lanes
Sie können Playlist-Lanes nach bestimmten 
Filterkriterien ein- oder ausblenden.

So filtern Sie Playlist-Lanes:

1 Klicken Sie mit der rechten Maustaste auf den 
Spur- oder Playlist-Namen.

2 Wählen Sie aus dem Rechtsklick-Menü eine der 
folgenden Optionen:

• Alle Spuren anzeigen 

• Nur Spuren anzeigen mit > Clips innerhalb der 

Edit-Auswahl 

• Nur Spuren anzeigen mit > Clips außerhalb der 

Edit-Auswahl 

• Show Only Lanes With > “Clips Rated >= 1–5” 

• Alle Spuren ausblenden 

• Nur Spuren ausblenden mit > Clips innerhalb 

der Edit-Auswahl 

• Nur Spuren ausblenden mit > Clips außerhalb 

der Edit-Auswahl 

• Hide Only Lanes With > “Clips Rated >= 1–5” 

Die Playlist-Lanes werden dann entsprechend ein- 
oder ausgeblendet.

Übereinstimmende 
alternative Clips
Mit Pro Tools können Sie Clips in der Haupt-
Playlist auf einer Spur mit übereinstimmenden 
alternativen Clips aus anderen Playlists derselben 
Spur, von anderen Spuren oder aus der Clipliste 
austauschen. Übereinstimmende alternative Clips 
sind Clips, die bestimmte Kriterien erfüllen. 
Beispielsweise Clips mit demselben Wert für User 
Time Stamp. 

Es gibt verschiedene Möglichkeiten, 
übereinstimmende alternative Clips in Pro Tools 
zu erstellen.

• Während der Punch-Aufnahme (Audio oder 
MIDI) erstellt Pro Tools übereinstimmende 
Clips für den ursprünglichen Clip (falls 
vorhanden) und den neuen im Punch-Verfahren 
aufgenommenen Clip. 

• Bei der Loop-Aufnahme (Audio oder MIDI) 
erstellt Pro Tools mehrere übereinstimmende 
Clips für jeden Aufnahmedurchlauf. 

• Beim Duplizieren von Playlists (Audio oder 
MIDI) entstehen übereinstimmende alternative 
Clips zwischen Playlists.

• Beim Importieren von Mehrkanal-Audiodaten 
aus einem Field Recorder werden 
übereinstimmende alternative Clips zwischen 
Kanälen erstellt.

Pro Tools bietet außerdem diverse Möglichkeiten 
zum Zugriff und Abhören mehrerer 
übereinstimmender alternativer Clips:

• Im Rechtsklick-Menü für Clips können Sie 
gemäß bestimmten Kriterien übereinstimmende 
alternative Clips auswählen.

• Im Popup-Menü für alternative Takes können 
Sie übereinstimmende alternative Clips 
auswählen.
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• Verwenden Sie den Befehl „Expand Alternates 
to New Tracks“, um übereinstimmende 
alternative Clips in neue Spuren zu kopieren.

• Verwenden Sie den Befehl „Expand Alternates 
to New Playlists“, um übereinstimmende 
alternative Clips in neue alternative Playlists auf 
derselben Spur zu kopieren. In der Playlists-
Darstellung können Sie dann auf die alternativen 
Playlists zugreifen.

Matching Criteria-Fenster
Im Matching Criteria-Fenster können Sie die 
Übereinstimmungskriterien für alternative Clips 
auswählen. Sie können so die Liste verfügbarer 
übereinstimmender Clips im Popup-Menü 
„Alternate Takes“ und im Clips-Rechtsklick-
Untermenü „Matches“ (Übereinstimmungen) 
verfeinern.

So konfigurieren Sie die Matching Criteria-
Optionen für übereinstimmende alternative Clips:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie das Selector- oder Grabber-Tool und 
klicken Sie mit der rechten Maustaste auf den 
Clip. Wählen Sie anschließend Matches > Match 

Criteria.

• Halten Sie bei Verwendung des Selector-Tools 
die Strg- (Windows) oder Befehlstaste (Mac) 
gedrückt, klicken Sie genau am Anfang des 
Loop- oder Punch-Bereichs und wählen Sie 
Match Criteria.

2 Wählen Sie im Matching Criteria-Fenster eine 
beliebige Kombination der folgenden 
Alternates Match-Optionen:

• Track ID

• Track Name

• Clip Rating

3 Wählen Sie unter In Addition To eine der 
folgenden Optionen:

• All

• Clip Start

• Clip Start and End

• Within Selection

• None

4 Lassen Sie das Matching Criteria-Fenster 
geöffnet, um die Einstellungen beim 
Zusammenstellen von Spuren nach Bedarf 
ändern zu können. Schließen Sie das Fenster, 
wenn Sie mit den Einstellungen fertig sind.Matching Criteria-Fenster

Sie können Übereinstimmungskriterien 
sowohl für MIDI- als auch Audioclips 
auswählen.

Matching Criteria-Einstellungen werden mit 
Ihrer Pro Tools-Session gespeichert.
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Matching Criteria-Optionen

Alternates Match-Optionen
Die folgenden Alternates Match-Optionen können 
in beliebiger Kombination ausgewählt werden.

Track ID. – sämtliche auf derselben Spur 
aufgenommenen Clips werden als 
übereinstimmend angesehen. Verwenden Sie diese 
Option, um alternative Takes bei der Loop- oder 
Punch-Aufnahme auszuwählen.

Track Name. – sämtliche Clips, die den gleichen 
Stammnamen haben wie die Spur oder Playlist, 
werden als übereinstimmend angesehen. So 
würden beispielsweise für eine Spur namens 
„Gtr.L“ die Clips „Gtr.L_01“ und „Gtr.L_02-01“, 
nicht aber „Guitar.L_01“ angezeigt. 

Clip Rating. – sämtliche Clips mit derselben 
Bewertung werden als übereinstimmend 
angesehen. Aktivieren Sie diese Option, wenn Sie 
über bewertete Clips verfügen (siehe „Bewerten 
von Clips“ auf Seite 623). 

Übereinstimmungsoptionen 
unter „In Addition To“
Die folgenden Übereinstimmungsoptionen unter 
„In Addition To“ schließen sich gegenseitig aus.

All. – sämtliche Clips, die die Zeitposition des 
Edit-Cursors enthalten, oder sämtliche Clips, 
die teilweise oder ganz innerhalb des aktuellen 
Zeitbereichs der Edit-Selektion liegen.

Clip Start. – sämtliche Clips, die über dieselbe 
Startzeit wie die Zeitposition des Edit-Cursors 
oder der Edit-Selektion verfügen.

Clip Start and End. – sämtliche Clips, die über 
dieselben Start- und Endzeiten wie die Edit-
Selektion verfügen.

Within Selection. – sämtliche vollständigen Clips, 
die komplett innerhalb der Edit-Selektion liegen.

None. – es werden zusätzlich zu den ausgewählten 
Alternates Match-Optionen keine weiteren 
Kriterien zum Filtern übereinstimmender 
alternativer Clips verwendet.
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Selektieren alternativer 
Takes auf Spuren
Alle Clips, die aus demselben Punch- oder Loop-
Aufnahmedurchgang stammen, haben eine 
identische Startzeit (den User Time Stamp-Wert). 
Sie können alternative Takes über das 
Kontextuntermenü „Matches“ oder das Popup-
Menü „Alternate Takes“ auswählen und abhören – 
sogar während der Wiedergabe.

So selektieren Sie einen alternativen Take:

1 Konfigurieren Sie ggf. das Matching Criteria-
Fenster (siehe „Matching Criteria-Fenster“ auf 
Seite 657).

2 Sie haben folgende Möglichkeiten:

• Wählen Sie das Selector- oder Grabber-Tool und 
klicken Sie mit der rechten Maustaste auf den 
Clip. Wählen Sie aus dem Matches-Untermenü 
des Popup-Menüs einen übereinstimmenden 
alternativen Take aus.

• Wenn der gerade in der Spur befindliche Take 
selektiert ist, halten Sie die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac) 
gedrückt und klicken Sie mit dem Selector-Tool 
auf eine beliebige Stelle des selektierten Takes. 
Nun können Sie einen anderen Take aus dem 
Popup-Menü „Alternate Takes“ wählen.

• Halten Sie bei Verwendung des Selector-Tools 
die Strg- (Windows) oder Befehlstaste (Mac) 
gedrückt und klicken Sie am genauen Anfang 
des Loop- oder Punch-Bereichs und wählen Sie 
einen anderen Take aus dem Popup-Menü 
„Alternate Takes“ aus.

Der selektierte übereinstimmende alternative Clip 
(Take) ersetzt den Clip in der Haupt-Playlist und 
wird genau an der richtigen Position ausgerichtet.

Um sicherzustellen, dass nachfolgende Aufnahme-
Takes über den gleichen User Time Stamp-Wert 
verfügen (und damit als übereinstimmende 
alternative Clips verfügbar sind), speichern Sie die 
Punch- und Loop-Aufnahmeselektion als Memory 
Location. Wenn Sie später zusätzliche Takes 
aufnehmen möchten, rufen Sie die entsprechende 
Memory Location auf. 

Um den User Time Stamp-Wert anderer Clips zu 
ändern, sodass diese als alternative 
übereinstimmende Clips für eine bestimmte 
Position verfügbar gemacht werden, verwenden 
Sie den Befehl Time Stamp im Menü „Clip List“. 

Matches-Kontextuntermenü

Alternate Takes-Popup-Menü
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Übereinstimmungen und 
mehrere Spuren
Wenn Sie auf mehreren Spuren eine Loop-
Aufnahme erstellt haben und jede Spur mehrere 
Takes mit identischen User Time Stamp-Werten 
enthält, können Sie alle Takes gleichzeitig ändern.

So wechseln Sie Takes für mehrere Spuren:

1 Konfigurieren Sie das Matching Criteria-
Fenster (siehe „Matching Criteria-Fenster“ auf 
Seite 657), sodass folgende Optionen aktiviert 
sind:

• Track Name 

• Within Selection

2 Wählen Sie mit dem Selector-Tool den Take-
Bereich für die einzelnen zu ersetzenden 
Spuren aus.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste in die 
Edit-Selektion und wählen Sie einen anderen 
übereinstimmenden Alternativ-Take aus dem 
Matches-Untermenü.

• Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf die 
Edit-Selektion und wählen Sie im Popup-Menü 
„Alternates“ einen anderen Take aus.

Der selektierte Take ersetzt den vorherigen Take 
und wird auf jeder Spur an der richtigen Position 
eingefügt.

Automatically Create New 
Playlists when Loop 
Recording
Bei der Loop-Aufnahme erstellt Pro Tools 
automatisch eine einzelne Datei, in der alle 
Aufnahmedurchgänge enthalten sind. Jeder 
Aufnahmedurchgang ist ein eigener Clip in der 
Datei. Auf der Spur wird nur der letzte 
Aufnahmedurchgang als Clip in der Haupt-Playlist 
angezeigt. Alle anderen Clips 
(Aufnahmedurchgänge) werden ausgeblendet, 
können jedoch als übereinstimmende alternative 
Clips (Takes) wieder aufgerufen werden.

Wenn die neue Option Automatically Create New 

Playlists When Loop Recording auf der Operation 
Preferences-Registerkarte aktiviert ist, wird 
automatisch jeder Clip (Take) in eine neue Playlist 
der Spur kopiert. Dies erleichtert die Nutzung der 
Playlists-Darstellung zum Abhören und 
Auswählen alternativer Takes.

So erstellen Sie automatisch neue Playlists bei der 
Loop-Aufnahme:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Operation-Registerkarte.

2 Aktivieren Sie im Bereich „Recording“ die 
Option Automatically Create New Playlists 

When Loop Recording.

3 Klicken Sie auf OK.

Weitere Informationen zu Loop-Aufnahmen 
finden Sie unter „Loop-Aufnahme von 
Audiomaterial“ auf Seite 470.
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Erweitern alternativer 
Takes auf neue Playlists 
oder Spuren
In Pro Tools können Sie alternative Takes und 
Kanäle in neue Playlists oder Spuren kopieren. 
Dies ist hilfreich beim Abhören, Bearbeiten und 
Mischen mehrerer alternativer Takes oder Kanäle. 
Alternative Takes werden bei der Punch- und 
Loop-Aufnahme erstellt. Alternative Kanäle sind 
in Dateien enthalten, die von einem Field Recorder 
aus in Pro Tools importiert wurden.

Erweitern alternativer Takes auf 
neue Playlists
Mit dem Erweitern alternativer Takes auf neue 
Playlists lässt sich das Spur-Compositing 
vereinfachen. Sobald Sie alternative Takes auf 
neue Playlists oder eine Spur erweitert haben, 
können Sie sie in der Playlists-Darstellung 
abhören und bearbeiten, um die besten Takes in 
der Haupt-Playlist zusammenzufassen.

So erweiten Sie alternative Takes auf 
neue Playlists:

1 Ermitteln Sie in der Haupt-Playlist den Clip mit 
übereinstimmenden alternativen Clips (Takes). 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste auf 
den Clip und wählen Sie Matches > Expand 
Alternates To New Playlists.

• Wenn der Clip bereits selektiert ist, verwenden 
Sie das Selector-Tool und klicken Sie bei 
gedrückter Strg-Taste (Windows) oder 
Befehlstaste (Mac) auf eine beliebige Stelle im 
selektierten Clip. Wählen Sie dann Matches > 
Expand Alternates To New Playlists.

• Wenn der Clip nicht selektiert ist, verwenden Sie 
das Selector-Tool und klicken Sie bei gedrückter 
Strg-Taste (Windows) oder Befehlstaste (Mac) 
genau auf die Anfangsposition des Loop- oder 
Punch-Bereichs. Wählen Sie dann Matches > 
Expand Alternates To New Playlists.

Sämtliche übereinstimmenden alternativen Clips 
werden in neue Playlists auf der Spur kopiert. Um 
alle Playlists der Spur anzuzeigen, wählen Sie die 
Playlists-Darstellung. Sie können auch in einer 
beliebigen Spurdarstellung über den Playlist-
Selektor eine verfügbare alternative Playlist als 
Haupt-Playlist auswählen.

Erweitern alternativer Takes 
auf neue Spuren
Durch Erweitern alternativer Takes auf neue 
Spuren wird das Abhören, Bearbeiten und 
Mischen alternativer Takes auf verschiedenen 
Spuren erleichtert.

So erweiten Sie alternative Takes auf neue Spuren:

1 Ermitteln Sie in der Haupt-Playlist den Clip mit 
übereinstimmenden alternativen Clips (Takes). 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit der rechten Maustaste auf den 
Clip und wählen Sie Matches > Expand 
Alternates To New Tracks.

• Wenn der Clip bereits selektiert ist, verwenden 
Sie das Selector-Tool und klicken Sie bei 
gedrückter Strg-Taste (Windows) oder 
Befehlstaste (Mac) auf eine beliebige Stelle im 
selektierten Clip. Wählen Sie dann Matches > 
Expand Alternates To New Tracks.

• Wenn der Clip nicht selektiert ist, verwenden Sie 
das Selector-Tool und klicken Sie bei gedrückter 
Strg-Taste (Windows) oder Befehlstaste (Mac) 
genau auf die Anfangsposition des Loop- oder 
Punch-Bereichs. Wählen Sie dann Matches > 
Expand Alternates To New Tracks.
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3 Wählen Sie dann eine der folgenden Optionen 
aus dem Untermenü „Expand Alternates To 
New Tracks“:

By Track Name. – benennt alle neuen Spuren nach 
dem Namen der Ausgangsspur.

By Clip Name. – benennt alle neuen Spuren nach 
den Namen der jeweiligen ursprünglichen Clips, 
die in der Matches-Liste angezeigt werden.

By Track and Clip Name. – benennt alle neuen 
Spuren nach dem Namen der Ausgangsspur und 
fügt die Namen der jeweiligen ursprünglichen 
Clips in Klammern hinzu.

Sämtliche übereinstimmenden alternativen Clips 
werden in neue Spuren kopiert.

Erweitern alternativer 
Kanäle auf neue Playlists 
oder Spuren
(Nur Pro Tools HD)

Wenn Sie mit einem Mono-Clip arbeiten, der Teil 
einer von einem Field Recorder importierten 
Mehrkanal-Aufnahme ist, können Sie diesen Clip 
(oder einen selektierten Teil davon) auf neue 
Playlists erweitern, die die mit ihm 
übereinstimmenden alternativen Kanäle 
widerspiegeln, und gleichzeitig sämtliche 
Bearbeitungen oder Fades beibehalten (siehe 
Kapitel 51: „Arbeit mit tragbaren Rekordern und 
Pro Tools“).

Bedingungen für die 
Verfügbarkeit alternativer Kanäle
Ein alternativer Kanal ist als Ersatz für den 
ursprünglichen Kanal verfügbar (dargestellt 
durch den Clip oder einen Teil des Clips in 
der Timeline-Selektion), wenn die folgenden 
Bedingungen zutreffen:

• Beide Kanäle gehören zu einer Mehrkanal-
Aufnahme, die gleichzeitig auf einem oder 
mehreren Field Recorders erstellt wurde.

• Bestimmte Metadaten sind für den 
ursprünglichen Kanal und den alternativen 
Kanal identisch.

• die beim Drehen eingebetteten Metadaten 
wurden vor dem Import in Pro Tools gesichert.

Bei Mehrkanal-Aufnahmen mit einem oder 
mehreren Field Recorders müssen sich beide 
Kanäle zwischen den Codepositionen für die Start- 
und Endzeit mindestens einmal überschneiden 
und darüber hinaus die folgenden 
Bedingungen erfüllen:

• Übereinstimmung bei Szene und Take

• Übereinstimmendes Aufnahmedatum (gilt nur, 
wenn Szene und Take Informationen für beide 
Kanäle enthalten)

• Übereinstimmender Bandname

• Übereinstimmender Tonrollenname

• Der Tonrollenname des alternativen Kanals 
stimmt mit dem Bandnamen des aktuellen 
Kanals überein

• Der Bandname des alternativen Kanals stimmt 
mit dem Tonrollennamen des aktuellen 
Kanals überein

Erweitern von Kanälen auf 
neue Playlists

So erweitern Sie alternative Kanäle auf 
neue Playlists:

1 Führen Sie in der Timeline einen der folgenden 
Schritte aus:

• Um nur einen Teil der Clips auf der Spur zu 
erweitern, treffen Sie eine Selektion, die eine 
beliebige Anzahl von Clips auf einer Spur 
beinhaltet oder überlappt, und klicken Sie 
mit der rechten Maustaste (Windows oder Mac) 
oder bei gedrückter Ctrl-Taste (Mac) auf 
die Selektion.
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• Um alle Clips auf der Spur zu erweitern, klicken 
Sie mit der rechten Maustaste (Windows oder 
Mac) oder bei gedrückter Ctrl-Taste (Mac) 
auf den Spurnamen.

2 Wählen Sie das Popup-Menü „Expand to 
New Playlists“ und wählen Sie hier eine 
der folgenden Methoden zum Erweitern 
alternativer Kanäle für die Selektion auf 
neue Spuren aus:

• Nach Kanalname

• Nach Kanalnummer

• Nach Kanalname und -nummer

• By Time Code Only

Wenn alternative Kanäle verfügbar sind, erweitert 
Pro Tools sie entsprechend der ausgewählten 
Option auf neue Playlists (darunter der Kanal 
der ursprünglichen Spur).

Erweitern von Kanälen auf 
neue Spuren

So erweitern Sie alternative Kanäle auf 
neue Spuren:

1 Führen Sie in der Timeline einen der 
folgenden Schritte aus:

• Um nur einen Teil der Clips auf der Spur 
zu erweitern, treffen Sie eine Selektion, 
die eine beliebige Anzahl von Clips auf einer 
Spur beinhaltet oder überlappt, und klicken Sie 
mit der rechten Maustaste (Windows oder Mac) 
oder bei gedrückter Ctrl-Taste (Mac) auf 
die Selektion.

• Um alle Clips auf der Spur zu erweitern, klicken 
Sie mit der rechten Maustaste (Windows oder 
Mac) oder bei gedrückter Ctrl-Taste (Mac) auf 
den Spurnamen.

2 Wählen Sie das Popup-Menü „Expand 
Channels to New Tracks“ und wählen Sie hier 
eine der folgenden Methoden zum Erweitern 
alternativer Kanäle für die Selektion auf neue 
Spuren aus:

• Nach Kanalname

• Nach Kanalnummer

• Nach Kanalname und -nummer

• By Time Code Only

Wenn alternative Kanäle verfügbar sind, erweitert 
Pro Tools sie entsprechend den gewählten 
Parametern auf neue Spuren (darunter der Kanal 
der ursprünglichen Spur).

Erweitern von Kanälen nur 
nach Timecode
Mit dem Befehl Expand To New Tracks By Time 

Code Only können Sie eine komplette Spur oder 
lediglich selektierte Clips auf neue Playlists in 
derselben Spur oder auf neue Spuren erweitern. 
Auf diese Weise werden alle anderen Clips, 
die an derselben Position im Timecode 
aufgenommen wurden, unabhängig von 
Kanalname oder -nummer angezeigt. Dies ist 
besonders dann hilfreich, wenn Sie bearbeitete 
Führungsspuren der ursprünglichen Audioquelle 
erweitern möchten, die mit Verweis auf den 
Timecode aufgenommen wurden, bei denen aber 
keine Kanalnamen oder -nummern in den 
Audiodateien vermerkt sind. 

Es ist nicht möglich, Dateien, die mit XML-
Metadaten kodiert sind, umzubenennen. Die 
Dateierweiterung wird immer .A1 und .A2 
sein (sogar für Stereodateien). Es ist 
außerdem nicht möglich, Dateien mit dem 
Suffix .L bzw. .R umzubenennen. Daher 
erkennt Pro Tools diese Kanäle nicht 
immer als Stereopaar.
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Beispiel-Workflow: Verwenden einer 
Führungsspur für Live-Konzertvideos

1 Mehrspurige Audioinhalte werden in Pro Tools 
bei laufendem Timecode aufgenommen. 
Gleichzeitig wird eine Mono- oder 
Stereomischung als Führungsspur für den 
Video-Cutter aufgenommen.

2 Bild- und Audio-Führungsspur werden in einer 
Anwendung für Videobearbeitung bearbeitet. 

3 Die bearbeiteten Audio-Führungsspuren 
werden vom Video-Cutter als AAF-(oder OMF-) 
Sequenzen exportiert und beinhalten 
Überhänge von mindestens 2 Bildern. 

4 Die AAF-(oder OMF-)Sequenz wird als 
neue Session in Pro Tools importiert. 
Die ursprünglichen Audiodateien und die 
unbearbeitete Führungsspur werden 
ebenfalls in die Session importiert.

5 Die unbearbeitete ursprüngliche Führungsspur 
wird wieder mit der Session gekoppelt 
(siehe „Neukoppeln der ursprünglichen, nicht 
bearbeiteten Führungsspur“ auf Seite 664).

6 Klicken Sie in Pro Tools mit der rechten 
Maustaste auf die Führungsspur und wählen 
Sie Expand Channels to New Tracks > By 

Timecode Only. Die ursprünglichen 
Ausgangsspuren werden auf neue Spuren mit 
Bearbeitungen und Fades, die der Führungsspur 
entsprechen, erweitert.

Neukoppeln der ursprünglichen, nicht 
bearbeiteten Führungsspur

Nach dem Importieren der AAF-(oder OMF-) 
Sequenz und der ursprünglichen Audio-
Quelldateien in die Session wird empfohlen, 
die bearbeitete Führungsspur neu mit den 
ursprünglichen, nicht bearbeiteten Quell-
Audiodaten zu koppeln.

So koppeln Sie die ursprüngliche, nicht 
bearbeitete Führungsspur neu:

1 Suchen Sie die Session im Workspace-Browser 
und öffnen Sie den Audio Files-Ordner. 

2 Klicken Sie mit der rechten Maustaste im 
Browser auf die Audiodatei mit der bearbeiteten 
Führungsspur und wählen Sie Relink Selected.

3 Suchen Sie im oberen Bereich des Relink-
Fensters die Audiodatei mit der ursprünglichen, 
nicht bearbeiteten Führungsspur, die in 
Pro Tools aufgenommen wurde. 

4 Wählen Sie im Select Files To Relink-
Fensterbereich die bearbeitete Führungsspur-
Datei.

5 Ziehen Sie die ursprüngliche, nicht bearbeitete 
Audiodatei mit der Führungsspur in den 
Candidates-Fensterbereich. Wenn ein 
Dialogfeld mit dem Inhalt angezeigt wird, dass 
eine oder mehrere Dateien kürzer als die 
Mediendatei sind, die Sie neu koppeln möchten, 
klicken Sie auf Yes, um sie dennoch für eine 
Neukopplung auszuwählen.

6 Aktivieren Sie das Kästchen links von der Datei 
im Candidates-Fensterbereich sodass ein 
Verknüpfungssymbol angezeigt wird. 

7 Klicken Sie im oberen Bereich des Relink-
Fensters auf Commit Links und schließen Sie 
das Relink-Fenster anschließend.

8 Jetzt können Sie mit der rechten Maustaste auf 
den Namen der Führungsspur klicken und 
Expand To New Tracks > By Timecode Only 
wählen. Alle erweiterten Spuren sollten nun 
synchron mit der Führungsspur sein.

Wenn die ursprüngliche, nicht bearbeitete 
Datei nicht verfügbar ist, können Sie eine 
Neukopplung mit einer beliebigen Audio-
Quelldatei vornehmen, solange diese 
dieselben Start- und Endzeiten wie die 
Führungsspur hat.
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Kapitel 30: Beat Detective

Beat Detective ist ein leistungsstarkes Tool zur 
Analyse und Bearbeitung von Audio- oder MIDI-
Daten mit ausgeprägten rhythmischen Merkmalen.

Beat Detective analysiert eine Audio- oder MIDI-
Selektion, identifiziert die Signalspitzen oder 
betonte Noten und erzeugt aus diesen oder aus 
MIDI-Noten Trigger-Punkte. Anhand dieser 
Trigger-Punkte kann Beat Detective folgende 
Aufgaben erfüllen: 

• Extrahieren von Tempo- und 
Schlaginformationen, aus denen Bar|Beat-
Marker erzeugt und eine Tempo-Map für die 
Session erstellt werden können. Siehe 
„Erzeugen von Bar|Beat-Markern mit Beat 
Detective“ auf Seite 676.

• Extrahieren von Tempo- und Groove-
Informationen als Groove-Vorlagen (sogenannte 
DigiGrooves). Diese Vorlagen können mithilfe 
von Beat Detective oder Groove Quantize auf 
Audio- und MIDI-Material angewendet werden 
(siehe „DigiGroove-Vorlagen“ auf Seite 677).

• Separieren einer Audioselektion in einzelne 
Clips, die an die Tempo-Map der Session oder 
an Groove-Vorlagen angepasst („quantisiert“) 
werden. Siehe „Separieren von Clips 
mit Beat Detective“ auf Seite 680 und 
„Anpassen von Clips mit Beat Detective“ auf 
Seite 681.

Beat Detective und 
Ausgangsmaterial
Die besten Ergebnisse erzielt Beat Detective bei 
Audio- und MIDI-Material mit ausgeprägten 
Attack-Phasen oder Betonungsmustern (das von 
den meisten in der Popmusik verwendeten 
Instrumenten wie Schlagzeug, Gitarre und 
Bass erzeugt wird). Beat Detective ist weniger 
geeignet für Audiomaterial, das weiche Attack-
Phasen oder Legatobewegungen aufweist, wie 
etwa Streichinstrumente oder Gesang.

Anwendungsbereiche 
für Beat Detective
Beat Detective kann etwa in folgenden Situationen 
sinnvoll eingesetzt werden:

Extrahieren von Tempodaten aus dem Audio- und 
MIDI-Material. – Beat Detective kann Bar|Beat-
Marker erzeugen, aus denen Tempodaten 
extrahiert werden, auch bei Audiomaterial mit 
verschiedenen Tempi oder mit Swing-Feeling. 
Die erzeugten Bar|Beat-Marker können auch zur 
Quantisierung anderer Audio- oder MIDI-Clips 
und -Events verwendet werden. 

Erstellen von DigiGrooves. – Beat Detective kann 
Groove-Vorlagen (sogenannte DigiGrooves) aus 
einer Audio- oder MIDI-Selektion extrahieren. 
Mit DigiGrooves kann der Groove oder das 
Feeling einer erfassten Passage in andere 
Audioselektionen (mit „Groove Conform“) 
oder MIDI-Daten (mit „Groove Quantize“) 
übernommen werden. 
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Anpassen von Audioclips. – Beat Detective kann 
Audiomaterial mit einem anderen Tempo oder mit 
verschiedenen Tempi an die aktuelle Tempo-Map 
der Session oder eine Groove-Vorlage anpassen, 
d. h. „quantisieren“. 

„Straffen“ von Performances. – bei manchen 
Audiomaterialien kann Beat Detective das Timing 
verbessern, indem das Durchschnittstempo errechnet 
und extrahiert wird und dann die rhythmischen 
Bestandteile (von Beat Detective separierte Clips) 
an die Tempo-Map der Session angepasst werden.

Loop-Anpassung. – Beat Detective kann Tempo- 
und Schlaginformationen aus Audio- und MIDI-
Material extrahieren und Audiomaterial an eine 
vorhandene Tempo-Map oder eine Groove-Vorlage 
angleichen. Dadurch können Sie Loops mit 
verschiedenen Tempi oder Grooves aneinander 
anpassen. Bei Loops mit einem anderen Tempo als 
die aktuelle Session können Sie mit Beat Detective 
schnell jeden Schlag im Loop separieren und an die 
vorhandene Tempo-Map anpassen (als Alternative 
zur Zeitkomprimierung oder Dehnung des Loops, 
durch die Tonhöhe und Klang des Audiomaterials 
verfälscht werden können). 

Remixes. – Beat Detective kann für Remixes oder 
zur Erstellung neuer Rhythmen verwendet werden. 
Dazu wird das Tempo aus den ursprünglichen 
Schlagzeugspuren oder mitunter der 
ursprünglichen Stereomischung extrahiert. Neue 
Audio- oder MIDI-Spuren können dann mit dem 
Ausgangsmaterial in Übereinstimmung gebracht 
werden oder dieses kann an neue 
Schlagzeugspuren angepasst werden, um so ein 
völlig neues Feeling zu erzeugen.

Bereinigen von Editiervorgängen in der 
Postproduktion (nur Audio). – die Edit 
Smoothing-Funktion in Beat Detective kann zum 
automatischen Bereinigen von Foley-Spuren 
verwendet werden, wenn diese viele Clips 
enthalten, die getrimmt und überblendet werden 
müssen. Beat Detective entfernt hier die stillen 
Passagen zwischen den Clips (sodass für die 
gesamte Spur der Raumeindruck bewahrt wird).

Anforderungen für 
Beat Detective
Beat Detective ist für alle Pro Tools-
Systeme erhältlich.

RAM-Anforderungen für Beat Detective

Beat Detective kann viel Arbeitsspeicher 
erfordern, vor allem wenn Sie mit mehreren 
Spuren und umfangreichen Audioselektionen 
arbeiten. Um Speicherengpässe mit Beat Detective 
zu vermeiden, haben Sie folgende Möglichkeiten:

• Wenn sich die Verarbeitungsgeschwindigkeit 
von Beat Detective verlangsamt, erweitern Sie 
den Arbeitsspeicher auf Ihrem Computer. 

• Sollte Ihr Rechner nicht über zusätzlichen 
Arbeitsspeicher verfügen, arbeiten Sie mit 
kürzeren Selektionen oder einzelnen Spuren.

• Wählen Sie als Editing-Voreinstellung für die 
Levels of Undo-Option einen kleineren Wert 
(siehe „Zahl der Undo-Vorgänge und Speicher“ 
auf Seite 537). Gewisse Editiervorgänge, etwa 
Edit Smoothing mit Beat Detective (nur für 
Audio), können sehr viel Speicherkapazität 
belegen, wenn sie Teil der Undo-Reihe sind.

Bei der Arbeit mit tickbasiertem Audio 
können Sie mit dem Clip Separation-Befehl 
von Beat Detective Audioclips schnell in 
einzelne „Hits“ (oder Slices) unterteilen. Sie 
können auch eine Clipgruppe der getrennten 
Clips erstellen, um das Editieren und 
Anordnen zu erleichtern.
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Das Beat Detective-Fenster
Die Verwaltung von Beat Detective erfolgt über das Beat Detective-Fenster.

Sie haben folgende Möglichkeiten, das Beat 
Detective-Fenster zu öffnen:

 Wählen Sie Event > Beat Detective.

 Drücken Sie Strg + 8 (Windows) bzw. Befehl + 
8 (Mac) auf dem Ziffernblock.

Beat Detective ist ein nicht verankertes Fenster, 
das Sie bei der Arbeit geöffnet lassen können. 
Dadurch können Sie die Steuerelemente bei der 
Wiedergabe in Echtzeit anpassen, während die 
Trigger-Punkte der Selektion im Edit-Fenster 
angezeigt werden.

Beat Detective-Modi
Das Beat Detective-Fenster ist in drei Abschnitte 
gegliedert: „Operation“, „Selection“ und 
„Detection“. Der unter „Operation“ gewählte 
Modus bestimmt, welche Steuerelemente unter 
„Detection“ angezeigt werden. Die Optionen unter 
„Selection“ sind in jedem Modus verfügbar.

Die Modi von Beat Detective sind:

Operation. – lässt Sie festlegen, ob MIDI- oder 
Audiomaterial analysiert werden soll.

Bar|Beat Marker Generation. – generiert 
Bar|Beat-Marker, die den Signalspitzen 
entsprechen, die in der Audioselektion gefunden 
wurden oder mit den Betonungsmustern von 
MIDI-Noten übereinstimmen.

Groove Template Extraction. – extrahiert 
rhythmische und dynamische Informationen 
aus dem Audio- oder MIDI-Material und 
speichert sie im Groove Clipboard oder als 
DigiGroove-Vorlage.

Clip Separation (nur Audio). – separiert anhand 
der in der Audioselektion gefundenen 
Signalspitzen neue Clips.

Clip Conform (nur Audio). – passt alle separierten 
Clips der Selektion an die aktuelle Tempo-Map an. 
Beat Detective kann Audioclips zusätzlich zur 
Standardquantisierung an Groove-Vorlagen 
(wie etwa DigiGroove) anpassen.

Edit Smoothing (nur Audio). – füllt die Lücken 
zwischen angepassten Clips, indem sie 
automatisch getrimmt und mit Crossfades 
versehen werden.

Beat Detective-Fenster
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Definieren einer Beat 
Detective-Selektion
Sie müssen stets den Audiobereich für die Analyse 
definieren, egal, ob Sie Bar|Beat-Marker erzeugen, 
DigiGroove-Vorlagen extrahieren oder Clips 
separieren möchten, die angepasst werden sollen. 
Das Beat Detective-Fenster bietet Funktionen, 
um Umfang, Taktart und Swing (Untereinheit) 
einer Audioselektion zu definieren und zu erfassen.

Damit die von Beat Detective erzeugten Trigger-
Punkte präzise an der richtigen metrischen 
Position gesetzt werden, müssen Länge und 
Taktart der Selektion korrekt definiert sein. 
Außerdem darf die Selektion keine Takt- oder 
Tempowechsel enthalten.

So selektieren Sie einen Bereich für 
Beat Detective:

1 Selektieren Sie im Edit-Fenster einen Audio- 
oder MIDI-Bereich auf einer oder 
mehreren Spuren.

Start- und Endpunkt der Selektion müssen exakt 
auf dem Schlag liegen. Um Start- und Endpunkt 
eines Audioclips genau zu bestimmen, zoomen Sie 
auf Sample-Darstellungsgröße und verwenden die 
Tab to Transients-Option (siehe „Springen zu 
Signalspitzen“ auf Seite 587).

2 Wählen Sie Event > Beat Detective.

3 Bei jeder neuen Selektion oder Änderung der 
Tempo-Map müssen Sie die Selektion neu 
definieren oder erfassen. Sie haben folgende 
Möglichkeiten, um die Selektion zu definieren:

• Wenn sich das Tempo und die Taktart der 
Audioselektion von den Standardeinstellungen 
der Session unterscheiden, geben Sie die Taktart 
und die Positionen für „Start Bar|Beat“ und 
„End Bar|Beat“ ein. Für einen Abschnitt mit vier 
Takten, der mit Schlag 1 beginnt, geben Sie 
1|1 und 5|1 ein.

• Wenn sich das Tempo und die Taktart der 
Audioselektion von den Standardeinstellungen 
der Session unterscheiden und Sie sich über die 
Länge des Materials nicht im Klaren sind, geben 
Sie die Taktart (Time Signature) und die Position 
für Start-Bar|Beat ein. Starten Sie die 
Wiedergabe und klicken Sie wiederholt auf 
Tap End B|B. Dadurch wird End Bar|Beat 
automatisch errechnet. Wenn Sie die Tap End 

B|B-Schaltfläche bei einem langen 
Selektionsabschnitt verwenden, müssen Sie 
so lange darauf klicken, bis sich der End 

Bar|Beat-Wert stabilisiert. Anschließend 
müssen Sie möglicherweise den Wert an die 
nächstgelegene Taktgrenze anpassen.

Um mit Beat Detective optimale Ergebnisse 
zu erzielen, sollte die selektierte Passage 
genau mit der Attack-Phase des ersten 
Schlags beginnen. 

Mit Loop Playback können Sie die 
Genauigkeit Ihrer Selektion überprüfen.

Damit die Edit-Selektion bestehen bleibt, 
während von einem beliebigen Punkt aus 
abgespielt oder geloopt wird, deaktivieren 
Sie „Options > Link Timeline and 
Edit Selection“.

Selektion eines Audiobereichs für Beat Detective

Damit die bestehende Selektion nicht 
verloren gehen kann, können Sie die Edit-
Selektion als Memory Location speichern und 
später erneut abrufen. Siehe Kapitel 36: 
„Memory Locations“.
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• Wenn das Tempo und die Taktart der Selektion 
denen der Session entsprechen (siehe „Berechnen 
des Tempos mit Beat Detective“ auf Seite 670) 
sowie Takte und Schläge von Selektion und 
Session übereinstimmen, klicken Sie auf die 
Capture Selection-Schaltfläche. Die korrekten 
Werte für Time Signature, Start Bar|Beat und 
End Bar|Beat werden automatisch eingefügt.

4 Um Noten mit Swing-Effekt in Beat Detective 
genauer analysieren zu können, wählen Sie 
die Contains-Option, die dem kleinsten 
Notenwert (Sub-Beat) der Selektion entspricht. 
Sie haben bei der Contains-Option die Auswahl 
zwischen Viertel-, Achtel-, Sechzehntel-, 
Zweiunddreißigstelnoten und Triolenzeichen. 
Die Standardeinstellung ist die Sechzehntelnote. 
Die ausgewählte Contains-Option bestimmt die 
Rasterpositionen für DigiGroove-Vorlagen.

Beat Detective-Analysen
Beat Detective bietet verschiedene 
Analysealgorithmen für die Beat-Erkennung, 
die für verschiedene Arten von Audiomaterial 
geeignet sind.

High Emphasis. – ist geeignet für hochfrequentes, 
unharmonisches Material, etwa Becken und Hi-
Hats, zu vermeiden für niederfrequentes Material.

Low Emphasis. – ist geeignet für niederfrequentes 
Material (etwa Bassgitarre und Kick-Drum) und 
das meiste harmonische Material (etwa Klavier 
oder Rhythmusgitarre).

Enhanced Resolution. – ist geeignet für den 
umfangreichsten Bereich an Material, 
wie vollständige Mixes und Loops.

Beat-Erkennung über mehrere Spuren hinweg

Bei der Analyse einer Selektion mit mehreren 
Spuren analysiert Beat Detective alle Spuren 
einzeln. In einer Spur gefundene Signalspitzen 
werden als Trigger-Punkte in allen ausgewählten 
Spuren angezeigt. Dabei spielt es keine Rolle, ob 
diese Signalspitze in einer anderen Spur enthalten 
ist. Bei eng abgestimmten Events in mehreren 
Spuren bestimmt Beat Detective jedoch nur die 
erste gefundene Signalspitze eines Beat-Events. 

Wenn Sie beispielsweise über vier 
Schlagzeugspuren verfügen (Kick, Snare und ein 
Paar Overheads), treten die Signalspitzen in 
Spuren der Overhead-Mikrofone etwas später auf, 
als die genaueren Mikrofone der Snare- und Kick-
Spuren, da der Weg von der Quelle zum Mikrofon 
länger ist. Wenn Sie eine Selektion in allen vier 
Spuren vornehmen und sie mit Beat Detective 
analysieren, werden nur die Signalspitzen aus 
Kick- und Snare-Spur als Trigger-Punkte 
bestimmt, da die Signalspitzen der Overheads für 
Bestandteile der gleichen Beat-Events (mit einer 
kurzen Verzögerung) gehalten werden. Weitere 
Informationen zur getrennten Analyse mehrerer 
Spuren finden Sie unter „Arbeiten im Collection-
Modus“ auf Seite 687.

Beat Detective, Selection-Optionen

Wenn das Audiomaterial korrekt an der 
Tempo-Map der Session ausgerichtet ist, 
können Sie die Capture Selection-Funktion 
für jede neue Selektion verwenden oder 
Änderungen an der Tempo-Map (etwa Tempo 
oder Taktart) vornehmen.

Die Selektionsdefinition steht nicht mehr zur 
Verfügung, wenn die Session geschlossen 
und wieder geöffnet wird.
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Berechnen des Tempos 
mit Beat Detective 
Wenn Sie die Taktart sowie den Start- und 
Endpunkt der Audioselektion kennen, können 
Sie das Tempo in Beat Detective berechnen.

So berechnen Sie das Tempo einer Selektion 
in Beat Detective:

1 Nehmen Sie eine Edit-Selektion im Edit-
Fenster oder in einem MIDI Editor-Fenster 
(nur MIDI) vor. Definieren Sie die Selektion im 
Beat Detective-Fenster, wie unter „Definieren 
einer Beat Detective-Selektion“ auf 
Seite 668 beschrieben.

2 Wählen Sie Bar|Beat Marker Generation.

3 Klicken Sie im Abschnitt „Detection“ 
(Modus „Normal“) auf Analyze.

4 Stellen Sie Sensitivity auf 0 % ein.

5 Klicken Sie auf Generate.

Bar|Beat-Marker werden automatisch am Anfang 
und Ende der Selektion erzeugt. Die Marker 
zeigen das Tempo und die Taktart des 
Materials an.

Erzeugen von Trigger-
Punkten
Sobald Sie die Selektion genau definiert haben, 
kann Beat Detective anhand der erkannten MIDI-
Noten oder Audiosignalspitzen Trigger-Punkte 
erzeugen. Umfang und Art der gefundenen 
Signalspitzen können mithilfe der Detection-
Einstellungen geändert werden, sodass Takte, 
Schläge und Untereinheiten (Sub-Beats) im 
Material beachtet und nichtrhythmische 
Komponenten ignoriert werden.

So erzeugen Sie Trigger-Punkte aus 
einer Audioselektion:

1 Selektieren Sie im Edit-Fenster einen 
Audiobereich.

2 Wählen Sie im Operation-Popup-Menü die 
Audio-Option.

3 Wählen Sie im Beat Detective-Fenster einen 
der folgenden Modi:

• Bar|Beat Marker Generation

• Groove Template Extraction 

• Clip Separation (nur Audio)

4 Definieren oder erfassen Sie die Selektion 
wie unter „Definieren einer Beat Detective-
Selektion“ auf Seite 668 beschrieben.

5 Wählen Sie im Analysis-Popup-Menü einen 
Erkennungsalgorithmus.

6 Klicken Sie auf Analyze.

7 Stellen Sie, abhängig vom Rhythmus der 
Selektion, die Resolution-Option auf Bars, 
Beats oder Sub-Beats ein.

8 Stellen Sie den Sensitivity-Wert so ein, dass auf 
den Schlägen und Sub-Beats der Selektion 
Trigger-Punkte angezeigt werden.

Beat Detective, Detection-Optionen

In Beat Detective erzeugte Bar|Beat-Marker, die 
Tempo und Taktart anzeigen.
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Trigger-Punkte für Takte sind durch breite Linien 
gekennzeichnet, Trigger-Punkte für Schläge durch 
mittelstarke Linien und solche für Sub-Beats durch 
dünne Linien. 

9 Sie können auf Sample-Darstellungsgröße 
zoomen und auf Scroll Next klicken, um zum 
nächsten Trigger der Selektion zu scrollen. 
Um zum vorherigen Trigger-Punkt zu gelangen, 
klicken Sie bei gedrückter Alt-Taste (Windows) 
oder Wahltaste (Mac) auf Scroll Next (siehe 
„Navigieren zu aufeinanderfolgenden Trigger-
Punkten“ auf Seite 676). So können Sie 
sicherstellen, dass sich die Trigger-Punkte an 
der richtigen Position befinden. Wenn zwischen 
den Schlägen oder Sub-Beats falsch platzierte 
Trigger-Punkte erscheinen, die Material 
außerhalb des rhythmischen Schemas markieren, 
löschen Sie diese (siehe „Löschen von Trigger-
Punkten“ auf Seite 674) oder verringern Sie den 
Sensitivity-Wert.

10 Um die metrischen Positionen für die 
Trigger anzuzeigen, wählen Sie die Show 

Trigger Time-Option.

11 Wenn die Trigger-Punkte nicht an der richtigen 
Position angezeigt werden, wiederholen Sie 
die Schritte 5 bis 10 unter Verwendung eines 
anderen Analysealgorithmus („High Emphasis“ 
oder „Low Emphasis“).

So erzeugen Sie Trigger-Punkte aus einer 
MIDI-Selektion:

1 Stellen Sie im Edit-Fenster für die MIDI-Spur, 
die Sie verwenden möchten, die 
Notendarstellung ein.

2 Wählen Sie im Edit-Fenster oder in einem 
MIDI Editor-Fenster einen Bereich von MIDI-
Noten aus. Achten Sie dabei darauf, dass Sie 
aussagekräftige Start- und Endpunkte für die 
Selektion wählen, etwa Taktstriche.

3 Wählen Sie Event > Beat Detective.

4 Wählen Sie im Operation-Popup-Menü die 
MIDI-Option.

5 Wählen Sie im Beat Detective-Fenster einen der 
folgenden Modi:

• Bar|Beat Marker Generation

• Groove Template Extraction 

6 Definieren Sie den Selektionsbereich. 
Wenn sich das Tempo und die Taktart der 
Audioselektion von den Standardeinstellungen 
der Session unterscheiden, geben Sie die 
Taktart (Time Signature) und die Positionen 
für Start Bar|Beat und End Bar|Beat ein. 
Für einen Abschnitt mit vier Takten, der mit 
Schlag 1 beginnt, geben Sie beispielsweise 
1|1 und 5|1 ein.

7 Wenn die MIDI-Spur Akkorde enthält, wählen 
Sie im Analysis-Popup-Menü einen der 
folgenden MIDI-
Akkorderkennungsalgorithmen aus:

• Last Note

• First Note

• Loudest Note

• Average Location

• Highest Note

• Lowest Note

8 Klicken Sie auf Analyze. 

Trigger-Punkte

LeisteBeat Sub-Beat
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MIDI-Akkorderkennung
Da MIDI-Noten in einem Akkord zu leicht 
unterschiedlichen Zeitpunkten gespielt werden 
können, werden eng beieinander liegende 
(weniger als die Hälfte des im Selection Contains-
Feld festgelegten Zeitwerts) Noten in Beat 
Detective als Akkord interpretiert. 

Die im Analysis-Popup-Menü festgelegten 
Kriterien werden in Beat Detective dazu 
verwendet, die Position des Schlags in 
Relation zum Akkord zu ermitteln.

Last Note. – legt den Trigger-Punkt auf den 
Anfang der letzten Note des Akkords.

First Note. – legt den Trigger-Punkt auf den 
Anfang der ersten Note des Akkords.

Loudest Note. – legt den Trigger-Punkt auf den 
Anfang der mit der höchsten Velocity gespielten 
Note des Akkords.

Average Location. – legt den Trigger-Punkt auf 
einen Punkt, der den Durchschnitt zwischen dem 
Anfang der ersten und der letzten Note im 
Akkord darstellt.

Highest Note. – legt den Trigger-Punkt auf den 
Anfang der höchsten Note des Akkords.

Lowest Note. – legt den Trigger-Punkt auf den 
Anfang der tiefsten Note des Akkords.

Realign Session
Die Realign Session-Funktion in Beat Detective 
ermöglicht das Generieren von Bar|Beat-Markern 
ohne Verschieben von tickbasiertem Material. 
Dies ist hilfreich beim Extrapolieren von Bar|Beat-
Markern aus tickbasierten Material, um die 
Tempo-Map und das Bar|Beat-Raster am 
tickbasiertem Material auszurichten. 

Normalerweise kann das Erstellen von Bar|Beat-
Markern bei tickbasiertem Material, etwa bei 
MIDI-Spuren und tickbasierten Audiospuren, 
dazu führen, dass tickbasiertes Material in der 
absoluten Zeit verschoben wird. Dies ist nützlich 
beim Ausrichten des tickbasierten Materials an 
Bar|Beat-Markern, die aus samplebasiertem 
Material erstellt wurden.

Beim Generieren von Bar|Beat-Markern in einer 
Session mit tickbasiertem Audio- oder MIDI-
Material haben Sie in Beat Detective die Wahl, 
die Position des tickbasierten Materials in der 
Session beizubehalten oder zuzulassen, dass das 
Material verschoben wird.

MIDI-Akkordanalyse

First
Note Last

Note

Highest Note

Lowest Note

Sie können tickbasiertes Material, 
beispielsweise eine MIDI-Performance, 
in samplebasiertes umwandeln und dann 
die Bar|Beat-Marker manuell einfügen.

Realign Session-Dialogfeld
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So erzeugen Sie Bar|Beat-Marker mit 
Beat Detective in einer Session mit 
tickbasierten Spuren:

1 Selektieren Sie im Edit-Fenster einen Audio- 
oder MIDI-Bereich.

2 Wählen Sie im Beat Detective-Fenster Bar|Beat 

Marker Generation.

3 Definieren oder erfassen Sie die Selektion wie 
unter „Definieren einer Beat Detective-
Selektion“ auf Seite 668 beschrieben.

4 Wählen Sie für Resolution die Option Bars 
oder Beats.

5 Klicken Sie auf Generate. 

6 Sie haben folgende Möglichkeiten:

• Aktivieren Sie im Realign Session-Dialogfeld 
Preserve Tick Position, wenn Sie zulassen 
möchten, dass tickbasiertes Material in absoluter 
Zeit verschoben wird.

• Wählen Sie Preserve Sample Position, wenn die 
absolute Position von tickbasiertem Material 
beibehalten werden soll. Diese Option kann 
etwa beim Hinzufügen einer Taktart und einer 
Tempo-Map zu einem frei gespielten 
Musikstück besonders nützlich sein.

7 Klicken Sie auf OK.

Tipps zum Setzen sinnvoller 
Trigger-Punkte
Überprüfen Sie anhand der folgenden Hinweise 
Ihre Trigger-Punkte:

 Um sich auf einen bestimmten Teilbereich zu 
konzentrieren, müssen Sie die Edit- und Timeline-
Selektion abkoppeln und den Wiedergabebereich 
einstellen, indem Sie auf eine beliebige Zeitbasis-
Leiste klicken oder darin ziehen.

 Überprüfen Sie die Breite der Trigger-Punkte 
und ihre Übereinstimmung mit dem 
Audiomaterial. Breite Trigger liegen auf 
Taktstrichen, mittelstarke auf Schlägen und dünne 
auf Sub-Beats. 

 Aktivieren Sie die Option unter Show Trigger 

Time und kontrollieren Sie, ob die 
(angenommenen) metrischen Positionen der 
Trigger-Punkte an dem Material ausgerichtet sind. 
Ein falsch platzierter Trigger-Punkt sollte 
verschoben oder gelöscht werden, da durch ihn 
nachfolgende Trigger ebenfalls an falsche Stellen 
rutschen (siehe „Bearbeiten von Trigger-Punkten“ 
auf Seite 674).

 Möglicherweise empfiehlt es sich, 
umfangreiche Selektionen in kürzere Abschnitte 
aufzuteilen, die sich einfacher handhaben lassen. 
So können Sie etwa mit 8 oder 4 Takte langen 
Abschnitten erheblich schneller Ergebnisse von 
besserer Qualität erzielen. 

 Beim Umschalten zwischen Audio- und MIDI-
Modus bleiben die Trigger-Punkte erhalten. 
Dadurch können MIDI-Trigger zur Bearbeitung 
von Audiomaterial verwendet oder Trigger-Punkte 
aus Kombinationen von MIDI- und Audiospuren 
gesammelt werden.

 Überlegen Sie bei Selektionen, die sich über 
mehrere Spuren erstrecken, ob diese einzeln oder 
im Collection-Modus editiert werden sollen. Siehe 
„Normaler und Collection-Modus für Detection“ 
auf Seite 686.
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Bearbeiten von Trigger-
Punkten
Obwohl Beat Detective eine breite Palette an 
Erkennungsmöglichkeiten für Signalspitzen 
bietet, müssen Trigger-Punkte mitunter 
gelöscht, verschoben oder manuell eingefügt 
werden. Außerdem können Sie Trigger-Punkte 
sperren, damit sie bei niedrigeren Sensitivity-
Einstellungen erhalten bleiben. 

Löschen von Trigger-Punkten
Wenn für die Analyse von leisem Material eine zu 
hohe Sensitivity-Einstellung gewählt wird, werden 
möglicherweise „falsche“ Trigger-Punkte erstellt, 
die keinem Schlag oder Sub-Beat im 
Ausgangsmaterial entsprechen. Diese falsch 
platzierten Trigger-Punkte können gesucht und 
manuell gelöscht werden.

So löschen Sie einen Trigger-Punkt:

1 Aktivieren Sie bei geöffnetem Beat 
Detective-Fenster im Edit-Fenster eines 
der Grabber-Tools.

2 Suchen Sie den falschen Trigger, der gelöscht 
werden soll. Signalspitzen bei falschen 
Triggern sind normalerweise kleiner als die der 
übrigen Trigger-Punkte und liegen oft zwischen 
den Sub-Beats.

3 Klicken Sie zum Löschen bei gedrückter Alt-
Taste (Windows) bzw. bei gedrückter Wahltaste 
(Mac) auf den Trigger.

Verschieben von Trigger-
Punkten
Sie können die Position der Trigger-Punkte 
ändern, um für die Attack-Phase der 
dazugehörigen Signalspitzen Platz zu schaffen 
oder geringfügige Abweichungen einzelner 
Signalspitzen vom Schlag zu kompensieren.

So verschieben Sie einen Trigger-Punkt:

1 Aktivieren Sie bei geöffnetem Beat 
Detective-Fenster im Edit-Fenster eines 
der Grabber-Tools.

2 Suchen Sie den Trigger-Punkt, den Sie 
verschieben möchten, und ziehen Sie ihn 
nach links oder rechts.

Löschen eines Trigger-Punkts

Verschieben eines Trigger-Punkts
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Einfügen von Trigger-Punkten
Wenn ein wichtiger Schlag oder Sub-Beat nicht 
erkannt wird, weil er zu leise ist, können Sie 
manuell einen Trigger-Punkt einfügen.

So fügen Sie einen Trigger-Punkt ein:

1 Aktivieren Sie bei geöffnetem Beat 
Detective-Fenster im Edit-Fenster eines 
der Grabber-Tools.

2 Klicken Sie auf die Stelle in der Selektion, 
an der Sie einen neuen Trigger-Punkt einfügen 
möchten. Nach Einfügen eines Trigger-Punkts 
können Sie diesen nach links oder rechts 
ziehen, um seine Position anzupassen 
(siehe „Verschieben von Trigger-Punkten“ auf 
Seite 674).

Sperren von Trigger-Punkten
Um sicherzustellen, dass wichtige Trigger-Punkte 
bei der Senkung des Sensitivity-Werts nicht 
verschwinden, können Sie sie sperren. Dies 
empfiehlt sich, wenn eine Selektion zahlreiche 
unerwünschte Trigger-Punkte aufweist bei einem 
Sensitivity-Wert, bei dem auch benötigte Trigger-
Punkte angezeigt werden (zu viele zum Löschen). 
Wenn ein niedrigerer Sensitivity-Wert auch die 
notwendigen Trigger zum Verschwinden bringen 
könnte, sollten Sie diese zuvor sperren.

So sperren Sie einen Trigger-Punkt:

1 Verschieben Sie den Sensitivity-Regler so weit, 
bis die gewünschte Signalspitze erkannt wird 
und ein Trigger-Punkt erscheint.

2 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf 
den Trigger-Punkt, um ihn zu sperren. 

3 Wiederholen Sie ggf. die Schritte 1 bis 2, 
um weitere Trigger-Punkte zu sperren.

4 Stellen Sie Sensitivity auf einen niedrigeren 
Wert ein, sodass die unerwünschten 
Trigger verschwinden.

Sobald die Trigger-Punkte gesperrt sind, 
verschwinden diese nur, wenn der Sensitivity-
Wert 0 % beträgt. Um die Sperrung für alle 
Trigger-Punkte der Selektion aufzuheben und so 
ihren ursprünglichen Zustand wiederherzustellen, 
klicken Sie auf die Analyze-Schaltfläche.

Neudefinieren der metrischen 
Position eines Trigger-Punkts
Es ist wichtig, dass Trigger-Punkte an der 
korrekten metrischen Position platziert werden. 
Wenn eine erfasste Signalspitze nicht genau auf 
dem Schlag liegt, weist Beat Detective dieser und 
den folgenden Signalspitzen in der Selektion 
möglicherweise die falsche metrische Position zu.

Wenn etwa der Taktschwerpunkt auf einer Note in 
der Bass-Spur liegt, diese jedoch zu früh gespielt 
wird, platziert Beat Detective die Note 
möglicherweise etwas vor dem Taktschwerpunkt. 
Wenn Sie den Clip mit dieser Note anschließend 
separieren und anpassen, wird er an die falsche 
Stelle verschoben. Nachfolgende Clips werden 
möglicherweise ebenfalls an die falschen 
Stellen verschoben.

Wenn sich Trigger-Punkte nicht an der korrekten 
metrischen Position befinden, weisen Sie ihnen 
mit „Identify Trigger“ die richtige Position zu.

Wenn Sie auf eine Stelle klicken, die zu dicht 
neben einem vorhandenen Trigger liegt, wird 
dieser an die neue Position verschoben.

Sperren eines Trigger-Punkts
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So ändern Sie die metrische Position eines 
Trigger-Punkts:

1 Doppelklicken Sie auf den Trigger-Punkt, 
dessen Position Sie ändern möchten: Das 
Identify Trigger-Dialogfeld wird geöffnet.

2 Geben Sie im Identify Trigger-Dialogfeld die 
korrekte Position für den Trigger ein und 
klicken Sie auf OK. 

Navigieren zu 
aufeinanderfolgenden 
Trigger-Punkten
Verwenden Sie Scroll Next, um von einem 
selektierten Trigger-Punkt zum nächsten zu 
navigieren. Um zum vorherigen Trigger-Punkt zu 
gelangen, klicken Sie bei gedrückter Alt-Taste 
(Windows) oder Wahltaste (Mac) auf Scroll Next. 
Besonders beim Editieren von aufeinander 
folgenden Trigger-Punkten in der Sample-Ansicht 
ist dies nützlich.

Erzeugen von Bar|Beat-
Markern mit Beat Detective
Sobald Beat Detective die Signalspitzen in der 
Selektion korrekt erkannt und Trigger-Punkte 
erzeugt hat, können Sie diese in Bar|Beat-Marker 
umwandeln. Aus in Beat Detective erzeugten 
Bar|Beat-Markern wird eine Tempo-Map erstellt, 
die während der gesamten Session verwendet 
werden kann.

Wenn eine Tempo-Map erzeugt wurde, können 
andere Audioclips und MIDI-Noten an die in 
Beat Detective erzeugten Bar|Beat-Marker 
angepasst werden.

Wenn Sie das Audiomaterial an die vorhandene 
Tempo-Map oder Groove-Vorlage der Session 
anpassen möchten, brauchen Sie keine Bar|Beat-
Marker aus dem Material zu erzeugen. Verwenden 
Sie Beat Detective stattdessen zum Separieren und 
Anpassen des Materials (siehe „Separieren von 
Clips mit Beat Detective“ auf Seite 680).

So erzeugen Sie Bar|Beat-Marker mit 
Beat Detective:

1 Treffen Sie eine Edit-Selektion.

2 Wählen Sie im Beat Detective-Fenster den 
Bar|Beat Marker Generation-Modus.

3 Definieren oder erfassen Sie die Selektion wie 
unter „Definieren einer Beat Detective-
Selektion“ auf Seite 668 beschrieben.

4 Legen Sie Resolution auf Bars oder Beats fest 
und konfigurieren Sie die Detection-Einstellung 
so, dass die Signalspitzen (oder MIDI-
Notenanfänge) der Selektion genau ermittelt 
werden (siehe „Erzeugen von Trigger-Punkten“ 
auf Seite 670).

Identify Trigger-Dialogfeld

Wenn Sie lediglich einen Teil an anderen 
Spuren ausrichten möchten, brauchen Sie 
wahrscheinlich keine Bar|Beat-Marker zu 
erzeugen.
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5 Klicken Sie auf Generate. 

Bar|Beat-Marker werden auf der Grundlage der 
Trigger-Punkte erzeugt und in der Tempo-
Leiste angezeigt.

Sub-Beats
Das Tempo wird aus Bar|Beat-Markern abgeleitet. 
Groove oder Feeling wird aus Sub-Beats abgeleitet 
bzw. daraus, wie diese vom vorgegebenen 
Temporaster abweichen. 

Um den Groove aus einer Selektion zu extrahieren, 
wählen Sie als Detection Resolution-Einstellung 
„Sub-Beats“. Dadurch werden rhythmische 
Vorgänge innerhalb jedes Takts (sofern vorhanden) 
beim Erzeugen von Bar|Beat-Markern einbezogen. 
Diese Bar|Beat-Marker können dann dazu 
verwendet werden, andere Audioclips oder MIDI-
Spuren zu quantisieren und sie so an die in Beat 
Detective erzeugten Bar|Beat-Marker anzupassen.

DigiGroove-Vorlagen
Beat Detective ermöglicht es, die rhythmische 
Feineinstellung zu extrahieren und als Groove-
Vorlage zu speichern. Diese Vorlagen werden als 
DigiGroove-Vorlagen bezeichnet. DigiGrooves 
können lokal in die Groove-Zwischenablage 
übertragen oder auf einem Datenträger als 
DigiGrooves gespeichert werden. 

Mit Groove-Vorlagen kann das Feeling einer 
Performance wie folgt übertragen werden:

• auf selektierte Audioclips mit Groove Conform 
(siehe „Groove Conform“ auf Seite 683)

• auf selektierte MIDI-Daten mit Groove 
Quantize (siehe „Groove Quantize“ auf 
Seite 943)

Groove-Vorlagen sind „Quantisierungs-Maps“, 
die aus tatsächlichen Performances abgeleitet 
werden. Der Rhythmus des Stücks wird analysiert 
und als Groove-Vorlage gespeichert. Beat 
Detective analysiert eine Audioselektion und stellt 
anhand eines festgelegten Schwellenwerts die 
Signalspitzen fest. Das Programm weist die 
rhythmischen Beziehungen einer Vorlage mit 
einer Auflösung von 960 Impulsen pro 
Viertelnote (ppq) zu.

Beim Erstellen von DigiGroove-Vorlagen 
analysiert Beat Detective auch die Dynamik der 
Wiedergabe. Aus MIDI-Spuren werden Velocity-
Daten für das MIDI-Material gespeichert, bei 
Audiodaten werden Akzente und Spitzenpegel als 
Velocity-Daten in die Groove-Vorlage 
übernommen und können zur Änderung der 
Dynamik von MIDI-Spuren verwendet werden. 

Bar|Beat-Marker („Resolution“ auf „Bars“ eingestellt)

Bar|Beat-Marker („Resolution“ auf „Beats“ eingestellt)

Zur Quantisierung von Clips oder MIDI-
Noten anhand von Bar|Beat-Markern auf 
Sub-Beats mit Swing-Feeling muss ein 
starrer Quantisierungswert verwendet 
werden, bei dem die Swing-Option zur 
Quantisierung deaktiviert wurde.
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Beat Detective setzt die Amplitude der Signale auf 
Audiospuren anhand einer linearen Skala in MIDI-
Velocity-Daten um. Ein Beispiel:

• Ein Signal mit 0 dBFS entspricht einer MIDI-
Velocity von 127.

• Ein Signal mit -6 dBFS entspricht einer MIDI-
Velocity von 64.

• Ein Signal mit -12 dBFS entspricht einer MIDI-
Velocity von 32.

• Ein Signal mit -48 dBFS entspricht einer MIDI-
Velocity von 1.

Die Erfassung dieser Informationen ist ein 
wichtiger Faktor zur Erhaltung des Feelings und 
kann zur qualitativen Verbesserung von MIDI-
Spuren mit eingeschränkter Dynamik beitragen. 

Extrahieren von Groove-
Vorlagen

So extrahieren Sie eine Groove-Vorlage:

1 Nehmen Sie im Edit-Fenster eine Edit-
Selektion vor (einschließlich Audio- oder 
MIDI-Material). Die Selektion sollte aus 
mindestens einem vollständigen Takt 
bestehen der von einem Taktschwerpunkt 
zum nächsten reicht.

2 Wählen Sie im Beat Detective-Fenster Groove 
Template Extraction.

3 Definieren oder erfassen Sie die Selektion wie 
unter „Definieren einer Beat Detective-
Selektion“ auf Seite 668 beschrieben.

4 Konfigurieren Sie die Detection-Optionen, 
sodass die Signalspitzen (oder MIDI-
Notenanfänge) der Selektion korrekt erkannt 
werden (siehe „Erzeugen von Trigger-Punkten“ 
auf Seite 670).

5 Klicken Sie auf Extract. 

6 Geben Sie im Extract Groove Template-
Dialogfeld Anmerkungen zum Groove ein. Sie 
können bis zu 255 Zeichen zur Beschreibung 
des Groove eingeben. Zum Anzeigen der 
Anmerkungen klicken Sie im Beat Detective-
Fenster auf „Show Info“.

7 Sie haben folgende Möglichkeiten:

• Um die extrahierte Vorlage zur Verwendung 
in der aktuellen Session verwenden zu können, 
sie jedoch nicht auf einen Datenträger zu 
speichern, klicken Sie auf Save To Groove 
Clipboard. (Diese Vorlage steht nicht mehr zur 
Verfügung, wenn Sie die aktuelle Session 
geschlossen haben.)

Beat Detective kann Daten zur Dauer 
nur von MIDI-, jedoch nicht von 
Audiospuren erfassen.

Beim Extrahieren von Groove-Vorlagen darf 
die erfasste Selektion keine Bar|Beat-Marker 
enthalten. sonst wird eine ungenaue Groove-
Vorlage extrahiert.

Extract Groove Template-Dialogfeld
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• Um die extrahierte Vorlage auf einen 
Datenträger zu speichern und anderen Sessions 
oder mit anderen Pro Tools-Anwendern 
gemeinsam zu verwenden, klicken Sie auf Save 
To Disk. Geben Sie einen Namen für die Vorlage 
ein und klicken Sie auf Save. (Wenn Sie den 
Speicherort von DigiGroove-Vorlagen und -
Ordnern ändern, stehen sie innerhalb der 
Sessions nicht mehr zur Verfügung). 

• Klicken Sie auf Cancel, um den Vorgang 
abzubrechen, ohne die Vorlage zu speichern. 

Swing-Inhalt beim Erzeugen 
von Groove-Vorlagen
Wenn Sie eine Selektion mit ausgeprägtem 
Achtelnoten-Swing definieren, wählen Sie als 
Contains-Option die Achtelnote. Wenn die 
Selektion relativ starre Achtelnoten aufweist, 
wählen Sie als Contains-Option die 
Sechzehntelnote. Dadurch kann die erzeugte 
DigiGroove-Vorlage einfacher auf andere 
Bereiche angewendet werden. Auch wenn ein 
Groove auf Material mit Achtelnoten ohne Swing 
basiert, können Sie die Vorlage auf Material mit 
Sechzehntelnoten anwenden. Wenn Material mit 
Sechzehntelnoten an eine Vorlage mit einer 
Achtelnotenauflösung angpasst wird, werden 
nebeneinander liegende Sechzehntelnoten 
derselben Achtelnotenposition zugeordnet.

Groove-Extrapolation
Zusätzlich zur Möglichkeit, Tempo-Daten aus 
verschiedenartigem Material zu extrahieren, bietet 
Beat Detective eine leistungsfähige Funktion zur 
„Groove-Extrapolation“. Dabei werden 
automatisch Trigger-Punkte abgeleitet und in 
Groove-Vorlagen einbezogen, obwohl keine 
entsprechende Signalspitze entdeckt wird. Bei 
einem Schlagzeug-Loop kann etwa der 3. Schlag 
fehlen und daher keine Signalspitze erkannt und 
kein Trigger-Punkt erzeugt werden. Beat 
Detective leitet den Trigger-Punkt für den 
3. Schlag in der Groove-Vorlage aus den 
anderen Trigger-Punkten in der Selektion ab.

Zusätzlich erhalten extrapolierte Trigger das 
Feeling der aus den erkannten Signalspitzen 
erstellten Trigger. Werden etwa in einem Kick-
Drum-Takt drei Trigger-Punkte erkannt, 
die 20 Ticks vor dem Schlag liegen, werden 
extrapolierte Trigger-Punkte ebenfalls 20 Ticks 
vor dem Schlag gesetzt.

Verwenden Sie Ordner und Unterordner, 
um DigiGroove-Vorlagen zu verwalten. 
Diese müssen sich jedoch immer unter 
Programme/Avid/Pro Tools/Grooves (Mac) 
bzw. C:\Programme\Avid\Pro Tools\Grooves 
(Windows) befinden. Groove-Vorlagendateien 
in anderen Ordnern stehen in Groove 
Quantize oder Beat Detective nicht 
zur Verfügung. 
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Separieren von Clips 
mit Beat Detective 
(Nur Audio)

Sobald in der Audioselektion Trigger-Punkte 
erscheinen, können diese zur Festlegung von Start- 
und Endpunkten für neue Clips verwendet werden, 
die sich automatisch separieren lassen. Die neuen 
Clips können an die bestehende Tempo-Map der 
Session oder an eine Groove-Vorlage 
angepasst werden.

Wenn Sie das Timing der Selektion ohne 
Änderung des Tempos bereinigen möchten, 
berechnen Sie zunächst das Tempo, indem Sie 
Bar|Beat-Marker erzeugen (siehe „Berechnen des 
Tempos mit Beat Detective“ auf Seite 670).

So separieren Sie Clips mit Beat Detective:

1 Selektieren Sie im Edit-Fenster einen 
Audiobereich.

2 Wählen Sie im Beat Detective-Fenster 
Clip Separation.

3 Definieren oder erfassen Sie die Selektion 
wie unter „Definieren einer Beat Detective-
Selektion“ auf Seite 668 beschrieben.

4 Konfigurieren Sie die Detection-Optionen so, 
dass die Signalspitzen der Selektion korrekt 
erkannt werden (siehe „Erzeugen von Trigger-
Punkten“ auf Seite 670).

5 Klicken Sie auf Separate. 

Clips werden auf Basis der erkannten Trigger-
Punkte separiert.

Trigger Pad

Beim Separieren von Clips wird im Beat Detective-
Fenster die Option „Trigger Pad“ angezeigt.

Geben Sie in diesem Feld einen Wert (zwischen 
0 und 50 ms) zur „Polsterung“ der Startpunkte 
von Clips ein, an denen sich der Separationspunkt im 
Verhältnis zum Trigger-Punkt (Signalspitze) 
befindet. Dadurch wird eine Leerstelle zwischen dem 
Start- und Sync-Punkt des Clips geschaffen, sodass 
die Attack-Phase des Materials erhalten bleibt.

Beim Anpassen separierter Clips werden diese 
anhand ihrer Sync-Punkte positioniert 
(siehe „Sync-Punkte“ auf Seite 862). 

Detection-Einstellungen, Clip Separation-Modus

Separierter Clip mit 20 ms „Trigger Pad“

Clip-Startpunkt
(Separationspunkt)

20 ms
Sync-Punkt 
(Trigger-Punkt)
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Separieren von Clips auf 
mehreren Spuren
Sie können Trigger-Punkte aus einer einzigen oder 
mehreren Spuren verwenden, um eine Gruppe von 
Spuren zu separieren. 

Im folgenden Beispiel ist die definierte Selektion 
ein Schlagzeug-Loop aus zwei 5/4-Takten. 
Das Material der Kick-, Snare-, Hi-Hat- und 
Overhead-Mikrofone wird auf separate Spuren 
aufgenommen.

Wenn Sie als Resolution-Option Beats auswählen 
und die Kick-Drum-Spur des Schlagzeug-Loops 
analysieren, platziert Beat Detective die Trigger-
Punkte an die Signalspitzen auf Schlag 1 und 4.

Wenn Sie die Selektion auf Snare-, Hi-Hat- und 
Overhead-Mikrofon-Spuren erweitern und dann 
separieren, werden anhand der Trigger-Punkte aus 
der Kick-Drum-Spur separate Clips auf allen 
Schlagzeugspuren an der gleichen Stelle erzeugt. 

Die separierten Clips können anschließend als 
Gruppe angepasst werden.

Sie können den Collection-Modus auch für 
mehrere Spuren verwenden. Im Collection-Mode 
können Sie Trigger-Punkte auf Spuren einzeln 
analysieren bzw. erkennen und ggf. nur bestimmte 
Trigger der aktuellen Spur zur Sammlung 
hinzufügen. Weitere Informationen finden Sie 
unter „Normaler und Collection-Modus für 
Detection“ auf Seite 686. 

Anpassen von Clips mit 
Beat Detective 
(Nur Audio)

Mit Beat Detective separierte Clips können unter 
Verwendung zweier Modi angepasst werden: 

Standard Conform. – verwendet die aktuelle 
Tempo-Map (Raster) der Session.

Groove Conform. – verwendet Groove-Vorlagen.

Beat Detective passt einen ausgewählten Clip 
unabhängig davon an, ob er in Beat Detective 
separiert wurde oder nicht. Um Clips mit Beat 
Detective anpassen zu können, müssen jedoch die 
Startpunkte der Clips mit dem Startpunkt des 
Materials übereinstimmen, das an den Takten und 
Beats der Session ausgerichtet wird. Dies sollte im 
Allgemeinen kein Problem darstellen, wenn die 
Clips nicht manuell separiert oder getrimmt, 
sondern in Beat Detective separiert wurden.

Kick-Drum-Spur mit Trigger-Punkten

Spuren von Kick-Drum, Snare, Hi-Hat und Overhead-
Mikrofonen mit Trigger-Punkten
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Standard Conform
Der Vorgang ist mit dem Befehl Clip > Quantize to 

Grid vergleichbar, es gibt aber einen wichtigen 
Unterschied: Beat Detective kann die Position 
aller Clips in einem Arbeitsschritt anpassen, 
unabhängig davon, ob sie einen konstanten oder 
einen Swing-Rhythmus aufweisen.

So passen Sie Clips mithilfe von Standard 
Conform an:

1 Wählen Sie im Beat Detective-Fenster 
Clip Conform.

2 Es muss auf jeden Fall Standard 
ausgewählt sein.

3 Wählen Sie im Edit-Fenster ggf. die separierten 
Clips aus, die Sie anpassen möchten. Start- und 
Endpunkt der Selektion müssen exakt auf dem 
Schlag liegen.

4 Definieren oder erfassen Sie im Beat Detective-
Fenster die Selektion wie unter „Definieren 
einer Beat Detective-Selektion“ auf 
Seite 668 beschrieben.

5 Um einzustellen, wie stark die Clips an das 
Raster (Tempo-Map) angepasst werden, wählen 
Sie die Strength-Option und geben Sie über den 
Schieberegler oder manuell einen 
Prozentwert ein: 

• Durch die Eingabe von niedrigen 
Prozentwerten bleibt das urprüngliche 
Feeling der Clips erhalten.

• Bei höheren Prozentwerten werden die Clips 
strenger an der Tempo-Map ausgerichtet. 100 % 
bedeutet völlige Angleichung ans Raster.

6 Um einzustellen, welche Clips angepasst 
werden, wählen Sie die Exclude Within-Option 
aus und geben Sie über den Schieberegler oder 
manuell einen Prozentwert ein.

• Niedrigere Prozentwerte führen dazu, dass 
Clips, die weiter entfernt vom Raster liegen, 
angepasst werden, während die Clips, die näher 
am Raster liegen, nicht angeglichen werden.

• Höhere Prozentwerte führen dazu, dass sowohl 
Clips, die nahe beim Raster liegen, als auch 
weiter entfernte angepasst werden.

7 Damit die angepassten Clips ein Swing-Feeling 
erhalten, wählen Sie die Swing-Option und 
geben Sie an, ob der Swing auf Achtel- oder 
Sechzehntelnoten basieren soll. Geben Sie 
anschließend über den Schieberegler oder 
manuell einen Prozentwert ein:

• Niedrige Prozentwerte produzieren weniger 
Swing, 0 % überhaupt keinen.

• Hohe Prozentwerte produzieren mehr Swing, 
100 % ein exakt triolisches Swing-Feeling.

• Prozentwerte zwischen 100 und 150 
verschieben die Clips über ein exakt triolisches 
Swing-Feeling hinaus in Richtung der nächsten 
Sechzehntelnote (vorausgesetzt, der Notenwert 
für Swing ist auf Achtelnoten gestellt).

Beat Detective, Standard Conform-Optionen

Um das ursprüngliche Feeling zu „straffen“, 
es gleichzeitig jedoch beizubehalten, setzen 
Sie „Strength“ auf 85 bis 88 %.

Um das ursprüngliche Feeling zu „straffen“, 
es gleichzeitig jedoch beizubehalten, setzen 
Sie „Exclude Within“ auf 10 bis 15 %.
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8 Klicken Sie auf Conform, um alle Clips in der 
Selektion automatisch anzupassen.

9 Hören Sie die neu angepassten Clips ab, indem 
Sie im Transport-Fenster auf „Play“ klicken. 

10 Sie haben folgende Möglichkeiten:

• Wählen Sie gegebenenfalls Edit > Undo, um die 
Schritte 4 bis 8 zu wiederholen und andere 
Conform-Einstellungen zu testen.

• Wenden Sie ggf. die Edit Smoothing-Funktion 
an (siehe „Edit Smoothing“ auf Seite 685).

Groove Conform
Statt eines Rasters auf Grundlage der Tempo-Map 
einer Session wird bei der Groove Conform-
Funktion ein Raster auf Grundlage einer Groove-
Vorlage oder DigiGroove verwendet. Mit 
DigiGrooves kann das Feeling einer erfassten 
Passage für die gewählten Audioclips 
übernommen werden. Informationen zum 
Erstellen von DigiGroove-Vorlagen finden Sie 
unter „DigiGroove-Vorlagen“ auf Seite 677.

So passen Sie Clips mithilfe von Groove 
Conform an:

1 Wählen Sie im Beat Detective-Fenster 
Clip Conform.

2 Wählen Sie Groove.

3 Wählen Sie im Edit-Fenster ggf. die separierten 
Clips aus, die Sie anpassen möchten. Start- und 
Endpunkt der Selektion müssen exakt auf dem 
Schlag liegen.

4 Definieren oder erfassen Sie im Beat Detective-
Fenster die Selektion wie unter „Definieren 
einer Beat Detective-Selektion“ auf 
Seite 668 beschrieben.

Wenn Beat Detective vor dem Separieren 
ausreichend Sub-Beats aus einer Selektion 
erfasst hat, können Sie Clips unter 
Verwendung der Swing-Option erfolgreich 
anpassen, um den Groove von einem eher 
starren Feeling zu einem swingenden zu 
ändern. Sie können auch eine Groove-
Vorlage mit einem Swing-Feeling 
importieren (siehe „Groove Conform“ auf 
Seite 683).

Mit Beat Detective angepasste Clips

Beat Detective, Groove Conform-Optionen

Beim Verwenden von Groove Conform darf 
die erfasste Selektion keine Bar|Beat-Marker 
enthalten, sonst wird eine ungenaue Groove-
Vorlage extrahiert.
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5 Wählen Sie im Groove Template-Popup-Menü 
die Option Groove Clipboard oder eine 
gespeicherte Groove-Vorlage. (Informationen 
zum Erstellen von Groove-Vorlagen finden Sie 
unter „DigiGroove-Vorlagen“ auf Seite 677).

6 Um Anmerkungen zu ausgewählten Vorlagen 
anzuzeigen, klicken Sie auf Show Info. 

7 Um einzustellen, wie stark die Clips an die 
Groove-Vorlage angepasst werden, wählen 
Sie die Timing-Option aus und geben Sie 
über den Schieberegler oder manuell einen 
Prozentwert ein. 

• Durch die Eingabe von niedrigen 
Prozentwerten bleibt das urprüngliche 
Feeling der Clips erhalten.

• Bei höheren Prozentwerten werden die Clips 
strenger am Raster der Groove-Vorlage 
ausgerichtet. 100 % bedeutet völlige 
Angleichung an das Raster.

• Wenn der Schieberegler auf 200 % gestellt ist, 
werden Clips an eine Position verschoben, 
die der zweifachen Differenz zwischen der 
ursprünglichen Position des Clips und der 
Position des Vorlagen-Events entspricht. 

Beispiel: Eine Sechzehntelnote in Takt 1|1|060 
entspricht dem Vorlagen-Event an Position 
1|1|073. Wenn der Schieberegler auf 100 % 
gestellt wird, wird die Note an Position 1|1|073 
verschoben. Wenn der Schieberegler auf 200 % 
gestellt wird, wird die Note an Position 
1|1|086 verschoben. 

8 Um das Material vor der Anwendung der 
Groove-Vorlage anzupassen, aktivieren Sie die 
Option Pre-Process Using Standard Conform.

Wenn diese Option aktiviert ist, passt Beat 
Detective Clips an die aktuellen Standard 
Conform-Einstellungen an, bevor die Groove-
Vorlage verwendet wird. Bei Ungenauigkeiten 
oder Fehlern in der Performance können mit Pre-

Process Using Standard Conform bessere 

Ergebnisse erzielt werden, da die Zuordnung von 
Takten, Schlägen und Sub-Beats vor Verwendung 
einer Groove-Vorlage überprüft wird. Durch 
Testen können Sie herausfinden, ob die 
Verwendung dieser Option angebracht ist. 

9 Klicken Sie auf Conform, um alle Clips in der 
Selektion automatisch anzupassen.

10 Hören Sie die neu angepassten Clips ab, indem 
Sie im Transport-Fenster auf „Play“ klicken. 

11 Sie haben folgende Möglichkeiten:

• Wählen Sie gegebenenfalls Edit > Undo, um die 
Schritte 4 bis 9 zu wiederholen und eine andere 
Groove-Vorlage oder andere Groove Conform-
Einstellungen zu testen.

• Wenden Sie ggf. die Edit Smoothing-Funktion 
an (siehe „Edit Smoothing“ auf Seite 685).

Wenn Audiomaterial an eine Groove-Vorlage 
mit ausgeprägtem Swing-Feeling angepasst 
wird, erzielen Sie durch Aktivieren von „Pre-
Process using Standard Conform“ oft 
bessere Ergebnisse.
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Edit Smoothing 
(Nur Audio)

Nach dem Anpassen gibt es möglicherweise 
Lücken zwischen Clips. Dadurch kann das 
Material bei der Wiedergabe unnatürlich klingen.

Beat Detective kann Lücken zwischen Clips 
automatisch füllen und bei Bedarf sogar 
Crossfades hinzufügen. Die Edit Smoothing-
Option kann auf Clips, die angepasst wurden, 
angewendet werden oder auf eine Spur mit 
zahlreichen Clips, die getrimmt und mit einem 
Crossfade versehen werden müssen (etwa in 
Soundeffekt-Spuren). Durch dieses automatisierte 
Glätten von Clipeditierungen entfällt 
stundenlanges und mühsames Editieren.

So verwenden Sie Edit Smoothing für 
angepasste Clips:

1 Wählen Sie im Beat Detective-Fenster 
Edit Smoothing.

2 Wählen Sie eine Smoothing-Option aus:

Fill Gaps. – wählen Sie diese Option aus, um 
Endpunkte der Clips so zu trimmen, dass die 
Lücken zwischen den Clips gefüllt werden.

Fill And Crossfade. – wählen Sie diese Option 
aus, um Endpunkte der Clips zu trimmen und vor 
jedem Startpunkt automatisch einen Pre-Fade 
(in ms) einzufügen.

3 Selektieren Sie im Edit-Fenster ggf. die 
angepassten Clips, die Sie mit der Edit 
Smoothing-Option bearbeiten möchten. Start- 
und Endpunkt der Selektion müssen exakt auf 
dem Schlag liegen.

4 Klicken Sie auf Smooth, um die Edits für die 
selektierten Clips zu glätten.

5 Hören Sie die Ergebnisse ab, indem Sie im 
Transport-Fenster auf „Play“ klicken. 

6 Wählen Sie gegebenenfalls Edit > Undo, um die 
Schritte 2 bis 5 zu wiederholen und einen 
anderen Crossfade Length-Wert zu testen.

Erstellen von Sync-Punkten 
durch Edit Smoothing
Nach dem Glätten von Editierungen in Beat 
Detective werden für die angepassten Clips 
automatisch Sync-Punkte (entsprechend den 
Startpunkten des Materials) erstellt. Dadurch 
können Sie die Clips später an eine andere Tempo-
Map oder anderen Groove-Vorlage anpassen oder 
andere Conform-Einstellungen verwenden. 

Sync-Punkte werden jedoch nur bei Bedarf 
erstellt: Bei der Clipanpassung entstehende 
Lücken können im Edit Smoothing-Modus 
mithilfe des Fill Gaps-Befehls gefüllt werden. 
Sync-Punkte werden am ursprünglichen 
Startpunkt des Clips erstellt. Wenn es zwischen 
den Clips keine Lücke gibt, wird durch das Edit 
Smoothing kein Sync-Punkt erstellt.

Beat Detective, Smoothing-Optionen

Clips vor und nach dem Edit Smoothing

Weitere Informationen zu Sync-Punkten von 
Clips finden Sie unter „Sync-Punkte“ auf 
Seite 862.
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Konsolidieren von Clips nach 
dem Edit Smoothing
Beim Separieren, Anpassen und Smoothing mit 
Beat Detective können sich Spuren mit vielen 
Clips und Crossfades ergeben. Wenn Sie mit 
mehreren Spuren arbeiten, kann die Dichte dieser 
Edits die Leistung Ihres Systems beeinträchtigen.

Wenn Sie mit den Ergebnissen aus Beat Detective 
zufrieden sind, empfiehlt es sich, die Spuren mit 
dem Consolidate-Befehl zu konsolidieren. 
Dadurch entsteht für alle selektierten Clips eine 
einzige, kontinuierliche Audiodatei, die sich 
leichter bearbeiten lässt. Siehe „Konsolidieren von 
Clips“ auf Seite 621. 

Normaler und Collection-
Modus für Detection 
In manchen Fällen kann es für Beat Detective 
schwierig sein, mehrere Spuren mit denselben 
Detection-Einstellungen zu analysieren. Mit dem 
Collection-Modus von Beat Detective können Sie 
ein Set von Trigger-Punkten auf verschiedenen 
Spuren zusammenfassen, wobei jeder Trigger-
Punkt eine andere Detection-Einstellungen 
aufweist. Diese Trigger-Punkte können dann 
zum Erzeugen von Bar|Beat-Markern oder 
DigiGroove-Vorlagen bzw. zum Separieren 
neuer Clips verwendet werden. Nur im Collection-
Modus können Trigger-Punkte auf einer Spur 
analysiert und auf einer anderen Spur 
übertragen werden.

Diese Methode, bei der selektiv Trigger-Punkte 
aus getrennten Analysedurchgängen auf 
verschiedenen Spuren hinzugefügt werden, bis nur 
die gewünschten Trigger bleiben, kann wesentlich 
effektiver sein als manuelles Löschen, Einfügen 
oder Ändern falsch gesetzter Trigger-Punkte.

Drum-Spuren und 
Collection-Modus
Stellen Sie sich vor, Sie arbeiten mit Drum-Spuren 
für Kick, Snare, Hi-Hat und Overhead-Mikros. 
Bei der Analyse einer Selektion, die sich 
über alle diese Spuren erstreckt, erhalten Sie 
möglicherweise viele unerwünschte Trigger, wenn 
Sie die Sensitivity so hoch einstellen, dass auch 
das Hi-Hat-Material (hauptsächlich von der Spur 
der Overhead-Mikros) erfasst wird. 

Wenn Sie jedoch nur die Spur für die Overhead-
Mikros analysieren, liegen die Trigger-Punkte 
etwas später als auf den anderen Spuren (der Schall 
erreicht die Overhead-Mikros später). Wenn Sie 
dann die Selektion auf die anderen Drum-Spuren 
ausdehnen und separieren, werden die Clips 
aus Kick-, Snare- und Tom-Spur etwas zu 
spät geschnitten.

Wenn die Leistung kein Problem darstellt, 
verwenden Sie den Clip Group-Befehl zum 
einfacheren Editieren und Bearbeiten von 
Clips. Er ist nützlich beim Anordnen von 
Schlägen, die mit Beat Detective 
ausgeschnitten wurden, besonders, wenn 
Sie die Tempi von tickbasierten 
Audiospuren ändern möchten. Weitere 
Informationen zu Clipgruppen finden Sie 
unter „Clipgruppen“ auf Seite 877.

Stellen Sie vor dem Konsolidieren einer 
großen Selektion über mehrere Spuren 
sicher, dass genügend Arbeitsspeicher 
verfügbar ist. Siehe „RAM-Anforderungen 
für Beat Detective“ auf Seite 666.
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Mithilfe des Collection-Modus können Sie alle 
Schlagzeugspuren getrennt und nacheinander 
analysieren. Dabei können Sie die Detection-
Einstellungen für jede Spur optimieren, bis Sie die 
gewünschten Trigger-Punkte erhalten. Sie können 
der Sammlung verschiedene Trigger für jede Spur 
oder jeden Trigger einer einzigen Spur hinzufügen. 
Anhand der Trigger-Sammlung können Bar|Beat-
Marker bzw. eine DigiGroove-Vorlage erzeugt 
oder neue Clips separiert werden.

Arbeiten im Collection-Modus
Der Collection-Modus steht im Bar|Beat Marker 
Generation-, Groove Template Extraction- oder 
Clip Separation-Modus zur Verfügung 
(nur Audio) und kann durch Auswählen 
von Collection im Detection-Popup-Menü 
aufgerufen werden.

So verwenden Sie den Collection-Modus:

1 Legen Sie im Edit-Fenster eine Audioselektion 
auf einer einzigen Spur fest. Start- und 
Endpunkt der Selektion müssen exakt auf dem 
Schlag liegen.

2 Wählen Sie im Beat Detective-Fenster einen der 
folgenden Modi:

• Bar|Beat Marker Generation

• Groove Template Extraction 

• Clip Separation (nur Audio)

3 Definieren oder erfassen Sie die Selektion wie 
unter „Definieren einer Beat Detective-
Selektion“ auf Seite 668 beschrieben.

4 Konfigurieren Sie die Detection-Optionen so, 
dass die Signalspitzen der Selektion korrekt 
erkannt werden (siehe „Erzeugen von Trigger-
Punkten“ auf Seite 670).

5 Wählen Sie im Detection-Popup-Menü die 
Collection-Option.

6 Klicken Sie im Detection-Abschnitt 
(Collection-Modus) auf Add All, 
um der Sammlung die aktuellen Trigger-
Punkte hinzuzufügen. 

7 Wählen Sie im Detection-Popup-Menü die 
Normal-Option und verschieben Sie die 
Selektion auf die nächste Spur, die Sie 
analysieren möchten. Die Selektion muss für 
alle Spuren gleich sein. 

Durch Overhead-Mikros erzeugte, verspätete 
Trigger-Punkte

Beat Detective, Collection-Modus-Optionen
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8 Konfigurieren Sie die Detection-Optionen so, 
dass die Signalspitzen der Selektion korrekt 
erkannt werden (siehe „Erzeugen von Trigger-
Punkten“ auf Seite 670).

9 Wählen Sie erneut Collection.

10 Sie haben folgende Möglichkeiten:

• Klicken Sie im Detection-Abschnitt 
(Collection-Modus) auf Add Unique, um der 
Sammlung nur die eindeutigen Trigger aus der 
Spur hinzuzufügen. Wenn Sie bestimmte 
Trigger hinzufügen möchten, sucht Pro Tools 
nach Triggern, die bereits in anderen Spuren 
gesammelten Triggern nahe sind. Wenn bereits 
Trigger vorliegen, werden die neu gefundenen 
Trigger verworfen.

• Klicken Sie auf Add All, um der Sammlung alle 
Trigger hinzuzufügen.

• Klicken Sie auf Clear All, um alle Trigger aus der 
Sammlung zu löschen.

Jedes neue Set von Triggern, das der Sammlung 
hinzugefügt wird, erscheint in einer anderen Farbe. 
Wenn aufeinander folgende Trigger in der 
Sammlung nahe beieinander liegen (etwa bei 
ungenügend abgeschirmten Mikrofonen) behält 
Beat Detective nur die zuerst gesetzten Trigger bei.

Drücken Sie Windows + P (Windows) bzw. 
Ctrl + P (Mac), um die Selektion nach oben zu 
verschieben. Drücken Sie Windows + Semikolon 
(Windows) bzw. Ctrl + Semikolon (Mac), um die 
Selektion nach unten zu verschieben.

Aktivieren Sie den Befehls-Tastaturfokus und 
drücken Sie die P-Taste, um die Selektion nach 
oben zu verschieben, oder die Semikolon-Taste, 
um die Selektion nach unten zu verschieben. 
Halten Sie die Umschalttaste gedrückt, um die 
aktuelle Selektion beizubehalten und 
zusätzliche Bereiche hinzuzufügen.
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11 Wiederholen Sie die Schritte 7 bis 10 für jede 
weitere Spur, die Sie analysieren.

Die Trigger-Punkte, die Sie im Collection-Modus 
speichern, werden mit Sessions gespeichert. Wenn 
Sie also eine Session später öffnen, sind die 
Trigger-Punkte aus der Sammlung noch 
vorhanden (bis Sie sie löschen). 

12 Sobald die Trigger-Punkte der Sammlung 
hinzugefügt wurden, können Sie sie zum 
Erzeugen von Bar|Beat-Markern oder Groove-
Vorlagen bzw. zum Separieren neuer Clips 
verwenden. Sie müssen dies jedoch im 
Collection Mode-Abschnitt erledigen (wenn die 
Trigger in mehreren Farben angezeigt werden).

Overhead Mikro-Spur mit einer Sammlung von Trigger-Punkten, die aus Kick-, Snare- und Hi-Hat-Spur 
zusammengestellt wurden.

1. Trigger-Punkte in einer Kick-Spur, die der 
Sammlung hinzugefügt werden

2. Bestimmte Trigger-Punkte in einer 
Snare-Spur, die der Sammlung 
hinzugefügt werden

3. Bestimmte Trigger-Punkte in einer 
Hi-Hat-Spur, die der Sammlung 
hinzugefügt werden

4. Gesammelte Trigger-Punkte, 
die auf die Overhead-Mikrofon-
Spur angewendet werden

Zum Separieren von Clips über mehrere 
Spuren hinweg muss die Selektion vor 
dem Separieren auf zusätzliche Spuren 
erweitert werden.
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Kapitel 31: Editieren von MIDI-Daten

Pro Tools stellt leistungsstarke MIDI-Editing-Tools 
zur Verfügung. Sie können einzelne MIDI-Noten 
und Controller-Events mit den Pencil-, Trimmer- 
und Grabber-Tools im Edit-Fenster, in den MIDI 
Editor-Fenstern (siehe Kapitel 32: „MIDI-
Editoren“) und im Score Editor-Fenster (Kapitel 33: 
„Score Editor“) erstellen und editieren.

Außerdem können Sie verschiedene Event-
Vorgänge (etwa Quantisieren, Transponieren, 
Ändern der Velocity und Ändern der Dauer) 
destruktiv auf ganze Gruppen von MIDI-Noten 
anwenden, um Tonhöhe, Timing, Dynamik 
und Phrasing zu verändern (siehe Kapitel 41: 
„Event Operations“). 

Ferner können Sie Echtzeit-Eigenschaften 
verwenden, wenn Sie MIDI-Daten bei der 
Wiedergabe oder beim Playthrough nicht 
destruktiv verändern wollen (siehe „MIDI-
Echtzeit-Eigenschaften“ auf Seite 726). 

Pro Tools gibt Ihnen außerdem zahlreiche Zoom- 
und Anzeigetools an die Hand, die speziell für das 
MIDI-Editing optimiert wurden.

Optionen für das MIDI-
Editing
Pro Tools bietet einige Optionen zur Festlegung des 
MIDI-Editing-Verhaltens. Diese Optionen sind im 
Edit-Fenster, in den MIDI Editor-Fenstern und im 
Score Editor-Fenster verfügbar. Jedoch sind diese 
Optionen nur verfügbar, wenn es mindestens eine 
MIDI- oder Instrumentenspur in Ihrer Pro Tools-
Session gibt.

Play MIDI Notes When Editing
Wenn die Play MIDI Notes When Editing-Option 
aktiviert ist, werden MIDI-Noten beim Editing 
wiedergegeben (sie senden einen Note On-Befehl). 

Default Note Duration
Mit der Default Note Duration-Option können 
Sie die Standardnotendauer für die manuelle 
Noteneingabe festlegen. Die Einstellungen für die 
Standardnotendauer können im Edit-Fenster, 
in den MIDI Editor-Fenstern und im Score Editor-
Fenster jeweils unterschiedlich sein.

Informationen zum Editieren von MIDI- 
und Audiosignalen in Clips finden Sie 
unter Kapitel 27: „Editieren von Clips und 
Selektionen“.

MIDI-Editing-Steuerelemente im Edit-Fenster

Play MIDI Notes When Editing

Default Note On Velocity

Default Note Duration
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So wählen Sie eine Standardnotendauer aus:

1 Klicken Sie im Edit-Fenster, in einem MIDI 
Editor-Fenster oder im Score Editor-Fenster auf 
die Einstellung „Default Note Duration“.

2 Wählen Sie den gewünschten Wert für die 
Standardnotendauer aus. (Wählen Sie 
beispielsweise die Option „1/4 note“, um mit 
dem Pencil-Tool Viertelnoten einzufügen.)

Die Einstellung für die Standardnotendauer 
wird aktualisiert und zeigt den ausgewählten 
Notenwert an.

3 Führen Sie einen der folgenden Schritte aus, 
um eine punktierte oder triolische Dauer 
zu definieren:

• Um die ausgewählte Standardnotendauer 
zu punktieren, klicken Sie auf die Einstellung 
„Default Note Duration“ und wählen Sie Dotted.

• Um aus der ausgewählten Standardnotendauer 
eine Triole zu machen, klicken Sie auf die 
Einstellung „Default Note Duration“ und 
wählen Sie Triplet.

Follow Grid

Aktivieren Sie die Option Follow Grid, wenn 
die Standardnotendauer sich am ausgewählten 
Rasterwert (Grid Value) orientieren soll. Um dies 
wieder zu beenden, wählen Sie den rhythmischen 
Wert für die Einstellung „Default Note Duration“.

Default Note On Velocity
Mit der Default Note On Velocity-Einstellung 
können Sie den Velocity-Standardwert für 
Notenanfänge (Note Ons) beim manuellen 
Einfügen von Noten festlegen. Die Einstellung für 
„Default Note On Velocity“ kann im Edit-Fenster, 
in den MIDI Editor-Fenstern und im Score Editor-
Fenster jeweils unterschiedlich sein.

Führen Sie einen der folgenden Schritte aus, 
um „Default Note On Velocity“ zu definieren:

 Klicken Sie im Edit-Fenster, in einem MIDI 
Editor-Fenster oder im Score Editor-Fenster auf 
die Einstellung „Default Note On Velocity“ und 
ziehen Sie den Wert nach oben oder unten.

 Klicken Sie im Edit-Fenster, in einem MIDI 
Editor-Fenster oder im Score Editor-Fenster auf 
die Einstellung „Default Note On Velocity“, 
geben Sie eine neue Zahl ein und drücken Sie 
die Eingabetaste.

Auswählen einer Standardnotendauer im Edit-Fenster

Standardnotendauer, Viertelnote ausgewählt

Default Note On Velocity
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Mirrored MIDI Editing
Mit dem sogenannten Mirrored MIDI Editing 
können Sie MIDI-Clips editieren und die 
Änderungen auf alle Kopien eines MIDI-Clips 
anwenden. Dies kann besonders beim Editieren 
von geloopten MIDI-Clips zweckdienlich sein.

Um „Mirrored MIDI Editing“ zu aktivieren, haben 
Sie folgende Möglichkeiten:

 Aktivieren Sie Options > Mirror MIDI Editing.

 Aktivieren Sie die Schaltfläche „Mirrored 
MIDI Editing“ im Edit-Fenster, MIDI Editor-
Fenster oder Score Editor-Fenster.

Im Mirrored MIDI Editing-Modus blinkt die 
Mirrored MIDI Editing-Schaltfläche einmal rot, 
wenn ein Editiervorgang ausgeführt wird. Dies ist 
ein Zeichen dafür, dass der Vorgang auf mehr als 
einen Clip angewendet wird.

Um „Mirrored MIDI Editing“ zu deaktivieren, haben 
Sie folgende Möglichkeiten:

 Deaktivieren Sie Options > Mirror MIDI Editing.

 Deaktivieren Sie die Schaltfläche „Mirrored 
MIDI Editing“ im Edit-Fenster, MIDI Editor-
Fenster oder Score Editor-Fenster.

Festlegen des Rasterwerts
Beim Einfügen von MIDI-Noten mit dem Pencil-
Tool bestimmt der Rasterwert (Grid Value) die 
Position für den Notenanfang jeder Note oder 
andere Merkmale, je nach Form des Pencil-Tools 
(siehe „Verwenden des Pencil-Tools“ auf 
Seite 696). Für das Edit-Fenster, die MIDI Editor-
Fenster und das Score Editor-Fenster können 
unterschiedliche Rasterwerte festgelegt werden.

So legen Sie den Rasterwert für das 
MIDI-Editing fest:

1 Klicken Sie auf den Grid Value-Selektor und 
wählen Sie „Bars|Beats“. Wenn die Option 
Follow Main Time Scale aktiviert ist, können Sie 
die Haupt-Zeitskala einfach auf „Bars|Beats“ 
einstellen (siehe „Einstellen der Haupt-
Zeitskala“ auf Seite 794).

2 Klicken Sie erneut auf den Grid Value-Selektor 
und wählen Sie einen Notenwert (etwa 1/4, 1/8 
oder 1/16) aus.

Mirrored MIDI Editing-Schaltfläche im Edit-Fenster

Wenn der Mirrored MIDI Editing-Modus 
deaktiviert ist und Sie Noten geloopter Clips 
in der Notendarstellung editieren, wird beim 
Edit-Vorgang der Loop in Clips umgewandelt. 
In ähnlicher Weise führt das Editieren von 
Clip-Gruppen dazu, dass die Gruppen 
separiert werden.

Auswählen eines Rasterwerts im Edit-Fenster
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3 Führen Sie einen der folgenden Schritte aus, 
um einen punktierten oder triolischen Wert 
zu definieren:

• Um den ausgewählten Rasterwert zu punktieren, 
klicken Sie erneut auf den Grid Value-Selektor 
und wählen Sie Dotted.

• Um aus dem ausgewählten Rasterwert eine 
Triole zu machen, klicken Sie erneut auf den 
Grid Value-Selektor und wählen Sie Triplet.

4 Überprüfen Sie die Einstellungen für 
Standardtaktart und -tempo der Session (siehe 
„Festlegen der Taktart der Session“ auf 
Seite 433 und „Festlegen des Tempos der 
Session“ auf Seite 434).

So blenden Sie Rasterlinien im Edit-Fenster oder 
in einem MIDI Editor-Fenster ein (oder aus):

 Aktivieren (bzw. deaktivieren) Sie die 
Grid-Schaltfläche.

Verwenden des Pencil-Tools
Das Pencil-Tool dient zum Erstellen und Editieren 
von MIDI-Daten. Mit den ersten fünf Formen des 
Pencil-Tools („Free Hand“, „Line“, „Triangle“, 
„Square“ und „Random“) können Sie MIDI-Noten 
mit unterschiedlichen Längen und Velocity-Werten 
erstellen. Im Edit-Fenster, in den MIDI Editor-
Fenstern und im Score Editor-Fenster werden die 
Velocity-Werte von Noten durch die Form des 
Pencil-Tools bestimmt). Die unterschiedlichen 
Formen des Pencil-Tools eignen sich besonders für 
das Zeichnen und Editieren der verschiedenen 
MIDI-Steuerungsdaten, etwa „Line“ für die 
Lautstärke, „Triangle“ für die Pan-Einstellungen, 
„Free Hand“ für die Tonhöhenbeugung und 
„Square“ oder „Random“ für die Velocity.

So wählen Sie die Form des Pencil-Tools:

1 Klicken Sie in der Symbolleiste auf das Symbol 
für das Pencil-Tool. Daraufhin wird das Popup-
Menü mit den Formen für das Tool angezeigt.

2 Wählen Sie die Pencil-Tool-Form.

Weitere Informationen zum Grid-Modus finden 
Sie unter „Grid-Modus“ auf Seite 545.

Grid-Schaltfläche im Edit-Fenster aktiviert

Parabolische und S-Kurven-Formen werden 
nur im Tempo-Editor zum Zeichnen von 
Tempo-Events verwendet. Siehe „Zeichnen von 
Tempo-Events“ auf Seite 806.

Für MIDI verfügbare Pencil-Tool-Formen
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Pencil-Tool-Formen für MIDI

Free Hand

Im Edit-Fenster in der Notendarstellung von MIDI- 
und Instrumentenspuren, in den MIDI Editor-
Fenstern und im Score Editor-Fenster wird mit der 
Form „Free Hand“ eine MIDI-Note eingefügt, deren 
Velocity-Wert durch die Einstellung „Default Note 
On Velocity“ definiert wird. Tonhöhe, Position und 
Dauer der Note werden durch die Stelle bestimmt, 
an die Sie mit der Maustaste klicken.

Beim Editieren von MIDI-Velocity- oder Continuous 
Controller-Daten können Sie mit der Free Hand-Form 
„freihändig“ zeichnen, indem Sie die Maus bewegen. 
Die Form wird in einer Reihe von Schritten gemäß der 
Voreinstellung „Pencil Tool Resolution When 
Drawing Controller Data MIDI“ wiedergegeben.

Line

Im Edit-Fenster in der Notendarstellung von MIDI- 
und Instrumentenspuren, in den MIDI Editor-
Fenstern und im Score Editor-Fenster wird mit der 
Form „Line“ eine Folge von MIDI-Noten einer 
Tonhöhe eingefügt, deren Velocity-Werte durch die 
Einstellung „Default Note On Velocity“ definiert 
wird. Dauer und Abstand der eingefügten Noten wird 
durch den aktuellen Rasterwert und die Einstellung 
„Default Note Duration“ bestimmt.

Beim Editieren von MIDI-Velocity- oder 
Continuous Controller-Daten zeichnet die Line-
Form eine gerade Linie von dem Punkt, auf den Sie 
klicken, bis zu dem Punkt, an dem Sie die Maustaste 
loslassen. Die MIDI-Continuous Controller-Werte 
ändern sich schrittweise entsprechend der Option 
Pencil Tool Resolution When Drawing Controller 

Data (auf der MIDI Preferences-Registerkarte).

Triangle

Im Edit-Fenster in der Notendarstellung von MIDI- 
und Instrumentenspuren, in den MIDI Editor-
Fenstern und im Score Editor-Fenster wird mit der 
Form „Triangle“ eine Folge von MIDI-Noten einer 
Tonhöhe eingefügt, deren Velocity-Werte zwischen 
der Einstellung „Default Note On Velocity“ und 
127 in einem Dreiecksmuster schwanken. Dauer 
und Abstand der eingefügten Noten wird durch den 
aktuellen Rasterwert und die Einstellung „Default 
Note Duration“ bestimmt.

Beim Editieren von MIDI-Velocity- oder 
Continuous Controller-Daten zeichnet die Triangle-
Form ein dreieckiges Muster, das in Abhängigkeit 
vom aktuellen Rasterwert seine Richtung ändert. 
Die MIDI-Controller-Werte ändern sich 
schrittweise entsprechend der Option Pencil Tool 

Resolution When Drawing Controller Data (auf der 
MIDI Preferences-Registerkarte).

Square

Im Edit-Fenster in der Notendarstellung von MIDI- 
und Instrumentenspuren, in den MIDI Editor-
Fenstern und im Score Editor-Fenster wird mit der 
Form „Square“ eine Folge von MIDI-Noten einer 
Tonhöhe eingefügt, deren Velocity-Werte zwischen 
der Einstellung „Default Note On Velocity“ und 
127 wechseln. Dauer und Abstand der eingefügten 
Noten wird durch den aktuellen Rasterwert und die 
Einstellung „Default Note Duration“ bestimmt.

Beim Editieren von MIDI-Velocity- oder 
Continuous Controller-Daten zeichnet die Square-
Form ein Rechteckmuster, das sich entsprechend 
dem aktuellen Rasterwert wiederholt.
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Random

Im Edit-Fenster in der Notendarstellung von MIDI- 
und Instrumentenspuren, in den MIDI Editor-
Fenstern und im Score Editor-Fenster wird mit der 
Form „Random“ eine Folge von MIDI-Noten einer 
Tonhöhe eingefügt, deren Velocity-Werte nach dem 
Zufallsprinzip im Bereich zwischen der Einstellung 
„Default Note On Velocity“ und 127 wechseln. 
Dauer und Abstand der eingefügten Noten wird 
durch den aktuellen Rasterwert und die Einstellung 
„Default Note Duration“ bestimmt.

Beim Editieren von MIDI-Velocity oder Continuous 
Controller-Daten zeichnet die Random-Einstellung 
eine Reihe von Zufallswerten, die sich entsprechend 
dem aktuellen Rasterwert verändern.

Einfügen von MIDI-Noten
In Pro Tools können Sie MIDI-Daten nicht nur 
aufnehmen, schrittweise aufnehmen und 
importieren, sondern mithilfe des Pencil-Tools 
auch manuell eingeben. 

So fügen Sie eine MIDI-Note in einer Spur im 
Edit-Fenster ein:

1 Stellen Sie im Edit-Fenster für die MIDI- oder 
Instrumentenspur die Notendarstellung ein. 

2 Wählen Sie das Pencil-Tool aus. Es muss auf 
„Free Hand“ eingestellt sein. Wenn Sie in der 
Notendarstellung den Cursor auf den Playlist-
Bereich einer MIDI-Spur setzen, nimmt er die 
Form eines Bleistifts (Pencil-Tool) an.

3 So fügen Sie Viertelnoten im Takt ein:

• Stellen Sie die Haupt-Zeitskala auf „Bars|Beats“ ein.

• Setzen Sie den Edit-Modus auf „Grid“.

• Stellen Sie den Rasterwert auf Viertelnoten ein.

• Legen Sie den Wert für „Default Note Duration“ 
auf Viertelnoten (oder auf Follow Grid) fest.

4 Bewegen Sie das Pencil-Tool über die Playlist der 
MIDI- oder Instrumentenspur. Verwenden Sie die 
Leiste im Edit-Fenster und das Mini-Keyboard der 
Spur als Referenz, um die gewünschte Tonhöhe 
und zeitliche Position zu bestimmen.

Beim Arbeiten mit dem Pencil-Tool werden 
Cursorposition und -wert in der Symbolleiste des 
Fensters angezeigt.

Beim Einfügen von MIDI-Noten oder 
anderen MIDI-Daten mit dem Pencil-Tool 
werden die Grenzen von MIDI-Clips an den 
nächstgelegenen Taktstrichen erstellt.

Cursorposition und -wert

Cursor-Tonhöhen-Position

Pencil-Cursor

Cursor-Timeline-Position
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5 Wenn Sie die gewünschten Werte für Tonhöhe und 
Zeit der einzufügenden Note erreicht haben, fügen 
Sie die Note mit einem Mausklick ein.

Der Velocity-Wert für eingefügte Noten wird von 
der Einstellung „Default Note On Velocity“ 
bestimmt. Die Dauer wird durch den Wert für 
„Default Note Duration“ bestimmt. Im Grid-Modus 
wird die Position für den Notenanfang durch den 
Rasterwert bestimmt. 

Wenn die Option „Play MIDI Notes When 
Editing“ aktiviert ist, erklingt jede Note beim 
Einfügen.

So lange Sie die Maustaste gedrückt halten, können 
Sie mit dem Pencil-Tool ziehen und so Tonhöhe und 
Dauer der eingefügten Note verändern. Ziehen Sie die 
Note nach rechts, um sie zu verlängern, ohne dabei 
ihren Anfangspunkt zu verändern. Ziehen Sie die Note 
nach links, um sie zu verkürzen, ohne dabei ihren 
Endpunkt zu verändern.

Einfügen einer Folge 
von Noten
Im Edit-Fenster und in den MIDI Editor-Fenstern 
können die verschiedenen Einstellungen des Pencil-
Tools („Line“, „Triangle“, „Square“ und 
„Random“) dazu verwendet werden, eine Folge von 
MIDI-Noten mit identischen Tonhöhen, jedoch 
unterschiedlichen Velocity-Werten einzugeben. 
Dauer und Abstand der eingefügten Noten wird 
durch den aktuellen Rasterwert und die Einstellung 
„Default Note Duration“ bestimmt. 

Wenn der Wert für „Default Note Duration“ 
größer als der Rasterwert ist, werden die 
eingefügten Noten gekürzt, sodass sie dem 
Rasterwert entsprechen und nicht überlappen.

Mit dem Pencil-Tool eingefügte MIDI-Note

Klicken Sie bei gedrückter Windows-Taste 
(Windows) oder Ctrl-Taste (Mac) und 
aktiviertem Smart-Tool (siehe „Verwenden 
des Smart-Tools“ auf Seite 566), sodass der 
Cursor die Form des Pencil-Tools annimmt, 
und geben Sie die MIDI-Noten ein. Zum 
Löschen der Noten klicken Sie bei gedrückter 
Wahl- und Ctrl-Taste (Mac) oder Alt- und 
Windows-Taste (Windows).

Bei aktiviertem Grid-Modus wird der 
Anfangspunkt der MIDI-Note automatisch an 
der nächstgelegenen Rastergrenze 
ausgerichtet. Drücken Sie bei ausgewähltem 
Pencil-Tool „Free Hand“ die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac) nach 
dem Klicken und Halten, um die Ausrichtung 
am Raster vorübergehend auszusetzen.

Einstellen der Dauer einer eingefügten Note

Bei aktiviertem Grid-Modus wird der 
Endpunkt der MIDI-Note automatisch am 
nächstgelegenen Rasterpunkt ausgerichtet. 
Drücken Sie die Strg-Taste (Windows) bzw. 
die Befehlstaste (Mac) und ziehen Sie das 
Pencil-Tool, um die Ausrichtung am Raster 
vorübergehend zu deaktivieren.
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Die Velocity-Werte der Noten hängen von der 
Form des Pencil-Tools ab.

• Verwenden Sie die Line-Form, um Noten mit 
identischen Velocity-Werten einzufügen.

• Verwenden Sie die Triangle-Form, um Noten 
mit an- und abschwellenden Velocity-
Werten einzufügen. 

• Verwenden Sie die Square-Form, um Noten mit 
abwechselnd hohen und niedrigen Velocity-
Werten einzufügen. 

• Verwenden Sie die Random-Form, um eine 
Folge von Noten mit nach dem Zufallsprinzip 
festgelegten Velocity-Werten einzufügen.

So fügen Sie beispielsweise eine Folge von Noten 
mit nach dem Zufallsprinzip festgelegten Velocity-
Werten im Edit-Fenster ein:

1 Stellen Sie im Edit-Fenster für die MIDI- oder 
Instrumentenspur die Notendarstellung ein. 

2 Wählen Sie das Pencil-Tool und vergewissern 
Sie sich, dass es auf „Random“ eingestellt ist.

3 Führen Sie folgende Schritte aus, um 
aufeinander folgende Viertelnoten im 
Takt einzufügen:

• Stellen Sie die Haupt-Zeitskala auf „Bars|Beats“ 
ein.

• Setzen Sie den Edit-Modus auf „Grid“.

• Stellen Sie den Rasterwert auf Viertelnoten ein.

• Legen Sie den Wert für „Default Note Duration“ 
auf Viertelnoten (oder auf Follow Grid) fest.

Mit diesen Einstellungen werden die eingefügten 
Noten im Abstand von jeweils einer Viertelnote 
voneinander positioniert.

4 Klicken Sie an die Position, um die erste Note 
einzufügen. Ziehen Sie dann, bis die gewünschte 
Anzahl von Noten eingefügt wurde.

Manuelles Editieren 
von MIDI-Noten
Alle Aspekte einer MIDI-Note können im Edit-
Fenster oder in einem MIDI Editor-Fenster 
bearbeitet werden, einschließlich Start- und 
Endpunkt, Notendauer, Tonhöhe und Velocity-
Werte. Grabber-, Pencil- und Selector-Tool 
können auf einzelne Noten, aber auch auf ganze 
Notengruppen angewendet werden.

Selektieren von MIDI-Noten
MIDI-Noten müssen vor dem Editieren 
selektiert werden.

Zum Selektieren von MIDI-Noten haben Sie 
folgende Möglichkeiten:

 Klicken Sie bei gedrückter Umschalttaste mit 
dem Pencil-Tool oder einem Grabber-Tool auf 
jede Note.

 Klicken Sie mit dem Grabber-Tool auf eine 
Stelle ohne Noten (das Fadenkreuz erscheint) 
und ziehen Sie ein Rechteck um die 
Notengruppe, die Sie editieren möchten.

Einfügen einer Notenfolge mit dem Pencil-Tool
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Wenn bei Verwendung eines Grabber-Tools ein 
Teil des Rechtecks eine Note berührt (ihren 
Anfangs- oder Endpunkt), wird diese Note in die 
Selektion aufgenommen. Eine Selektion mit einem 
Grabber-Tool ist jedoch eine Objekt-Selektion. Die 
der MIDI-Spur zugrunde liegenden Controller- und 
Automation-Daten werden nicht mit 
eingeschlossen.

 Ziehen Sie mit dem Selector-Tool über den 
gewünschten Notenbereich.

Bei Verwendung des Selector-Tools werden nur 
solche Noten in die Selektion aufgenommen, deren 
Anfangspunkt im Selektionsbereich liegt. Wenn 
eine MIDI- oder Instrumentenspur in der Noten- 
oder Clips-Darstellung angezeigt wird, werden mit 
dem Selector-Tool Bereiche selektiert und auch 
zugrunde liegende Controller- und Automation-
Daten eingeschlossen.

So entfernen Sie eine oder mehrere Noten 
aus einer Selektion:

 Klicken Sie mit dem Pencil- oder einem 
beliebigen Grabber-Tool bei gedrückter 
Umschalttaste auf die entsprechenden Noten, 
damit diese aus der Selektion entfernt werden.

Selektieren und Abhören 
von MIDI-Noten mit dem 
Mini-Keyboard
Verwenden Sie das Mini-Keyboard für MIDI- und 
Instrumentenspuren, um Noten auf der jeweiligen 
Spur zu selektieren und wiederzugeben. Sie können 
mit einem beliebigen Edit-Tool auf das Mini-
Keyboard klicken.

So geben Sie eine Note in einer MIDI- oder 
Instrumentenspur wieder und selektieren auf der 
Spur alle Noten in der betreffenden Tonhöhe:

 Klicken Sie mit ausgewähltem Edit-Tool auf 
eine Taste des Mini-Keyboards.

Selektieren einer Notengruppe mit einem Grabber-Tool

Auswählen von Noten mit dem Selector-Tool

Klicken Sie bei ausgewähltem Selector-Tool und 
gedrückter Alt-Taste (Windows) bzw. Wahltaste 
(Mac), um das Note Selector-Tool im Edit-
Fenster und in den MIDI Editor-Fenstern 
aufzurufen. (Im Score Editor-Fenster selektiert 
das Selector-Tool immer Noten.) Mit dem Note 
Selector-Tool werden alle MIDI-Noten im 
Zeitraum der Selektion als Objekte selektiert. 
Andere MIDI-Events (wie Controller-Daten oder 
Program Changes) werden nicht selektiert.

Sie können auch im Select/Split Notes-
Fenster Noten selektieren. Siehe „Select/
Split Notes“ auf Seite 959.
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So wählen Sie einen Notenbereich in einer MIDI- 
oder Instrumentenspur aus und geben ihn wieder:

 Klicken Sie mit ausgewähltem Edit-Tool auf 
eine Taste und ziehen Sie auf dem Mini-
Keyboard nach unten oder oben.

Selektieren nur von MIDI-Noten 
mit dem Note Selector-Tool
In der Noten- oder Velocity-Darstellung kann bei 
MIDI- und Instrumentenspuren im Edit-Fenster 
oder in einem MIDI Editor-Fenster mit dem 
Selector-Tool eine Zeitbereichsselektion getroffen 
werden, die zusätzlich zu MIDI-Noten und 
Velocity-Werten alle MIDI-Event-Typen 
beinhaltet (beispielsweise Program Changes oder 
Continuous Controller-Daten). Das Note Selector-
Tool kann verwendet werden, um nur MIDI-Noten 
und Velocity-Werte in einer Zeitbereichsselektion 
zu selektieren. 

So selektieren Sie mit dem Note Selector-Tool nur 
MIDI-Noten und Velocity-Werte:

1 Aktivieren Sie das Selector-Tool.

2 Halten Sie bei MIDI- oder Instrumentenspuren 
im Edit-Fenster in der Noten- oder Velocity-
Darstellung oder in einem MIDI Editor-Fenster 
die Alt-Taste (Windows) bzw. die Wahltaste 
(Mac) gedrückt und ziehen Sie über den 
Zeitbereich, der die gewünschten Noten enthält.

Wenn Sie das Smart-Tool verwenden und die Alt-
Taste (Windows) bzw. die Wahltaste (Mac) 
drücken, steht das Selector-Tool im oberen Bereich 
der Spur zur Verfügung; das Note Selector-Tool 
steht im unteren Bereich der Spur zur Verfügung.

Wiedergeben einer Note mit dem Mini-Keyboard und 
Selektieren aller Noten der betreffenden Tonhöhe

Klicken Sie bei gedrückter Alt-Taste 
(Windows) oder Wahltaste (Mac), 
um Noten wiederzugeben, ohne eine 
Selektion vorzunehmen.

Klicken Sie bei gedrückter Strg-Taste 
(Windows) oder Befehlstaste (Mac), um Noten 
zu selektieren oder die Selektion aufzuheben 
sowie um eine nicht zusammenhängende 
Selektion vorzunehmen.

Wiedergeben eines Notenbereichs mit dem 
Mini-Keyboard und Selektieren aller Noten mit 
den betreffenden Tonhöhen

Sie können auch bei gedrückter Umschalttaste auf 
das Mini-Keyboard klicken, um den Notenbereich 
zu vergrößern oder zu verkleinern.

Selektieren nur von MIDI-Noten mit dem Note 
Selector-Tool
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Verwenden des Grabber-Tools
Verwenden Sie die Grabber-Tools, um Clips 
auf Spuren zu selektieren, zu verschieben, 
zu trennen oder anzuordnen. Für das Grabber-Tool 
gibt es drei Modi: Time Grabber, Separation 
Grabber und Object Grabber. Weitere Informationen 
zum Anordnen von Clips finden Sie auch unter 
Kapitel 37: „Anordnen von Clips“.

Transponieren von Noten
Sie können MIDI-Noten transponieren, indem 
Sie sie mit dem Pencil-Tool oder einem beliebigen 
Grabber-Tool nach oben oder unten ziehen. Wenn 
mehrere Noten selektiert wurden, werden sie alle 
transponiert.

So transponieren Sie eine MIDI-Note:

1 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Notendarstellung an.

2 Aktivieren Sie das Pencil-Tool oder eines der 
Grabber-Tools.

3 Ziehen Sie die Note bei gedrückter 
Umschalttaste nach oben oder unten.

Durch das Drücken der Umschalttaste wird 
sichergestellt, dass die transponierte Note 
ihren Anfangspunkt behält. 

Während des Ziehens wird jede neue Note 
akustisch wiedergegeben und die aktuelle 
Cursorpositionswert-Anzeige im Edit-Fenster 
zeigt die Anzahl der Halbtonschritte sowie 
die Richtung (+/–) der Transposition an.

Transponieren mit einem Grabber-Tool

Halten Sie die Befehlstaste (Mac) oder die 
Windows-Taste (Windows) gedrückt und 
drücken Sie die Plus-Taste (+) auf dem 
Ziffernblock, um die ausgewählten MIDI-
Noten um einen Halbton nach oben zu 
transponieren, oder drücken Sie die Minus-
Taste (–) auf dem Ziffernblock, um die 
selektierten MIDI-Noten um einen Halbton 
nach unten zu transponieren.

Um die Kopie einer Note zu transponieren, 
ohne dabei die Originalnote zu ändern, 
drücken Sie beim Ziehen der Note die Alt-
Taste (Windows) bzw. die Wahltaste (Mac).

MIDI-Noten können auch mithilfe des Event-
Vorgangs „Transpose“ (siehe „Transpose“ 
auf Seite 956) oder der MIDI-Echtzeit-
Eigenschaften (siehe „MIDI-Echtzeit-
Eigenschaften“ auf Seite 726) transponiert 
werden. 
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Verschieben von Noten
Ähnlich wie Clips können auch MIDI-Noten mit 
dem Pencil-Tool oder einem Grabber-Tool nach 
rechts oder links verschoben werden, um ihren 
Anfangspunkt zu ändern. Wenn vor dem 
Verschieben mehrere Noten selektiert sind, 
werden alle gemeinsam verschoben.

So verschieben Sie eine MIDI-Note:

1 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Notendarstellung an.

2 Ziehen Sie die Note mit dem Pencil-Tool oder 
einem Grabber-Tool nach rechts oder links. 
(Halten Sie die Umschalttaste gedrückt, wenn Sie 
die Tonhöhe der Note beibehalten möchten.)

Beim Verschieben der Note zeigt die aktuelle 
Cursorpositionswert-Anzeige im Edit-Fenster den 
jeweiligen neuen Anfangspunkt an.

Wenn der Edit-Modus auf „Grid“ eingestellt ist, 
wird die verschobene Note automatisch am 
nächstgelegenen Rasterpunkt ausgerichtet. Wenn 
der Edit-Modus auf „Spot“ eingestellt ist, öffnet 
sich das Spot-Dialogfeld.

Trimmen der Anfangs- und 
Endpunkte von Noten
Ähnlich wie bei Clips können auch die Anfangs- und 
Endpunkte von MIDI-Noten mit dem Trim-Tool 
geändert werden. Wenn mehrere Noten selektiert 
wurden, werden all diese Noten verändert.

So ändern Sie die Anfangs- und Endpunkte einer 
Gruppe von MIDI-Noten:

1 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Notendarstellung an.

2 Klicken Sie bei gedrückter Umschalttaste mit 
dem Pencil-Tool oder einem Grabber-Tool auf 
die zu trimmenden Noten.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie das Trim-Tool. 

• Verwenden Sie das Pencil-Tool.

4 Bewegen Sie den Cursor an den Anfang einer 
beliebigen ausgewählten Note, sodass das 
Trim-Tool erscheint. Ziehen Sie nach rechts, 
um die Dauer der Noten zu verkürzen, oder 
nach links, um sie zu verlängern.

Um die ausgewählten Noten zu kopieren, 
ohne die Originalnoten dabei zu ändern, 
drücken Sie beim Ziehen der Noten die Alt-
Taste (Windows) bzw. die Wahltaste (Mac).

Die Positionierung von MIDI-Noten kann 
auch mit dem Shift-Befehl (siehe „Shift-
Befehl“ auf Seite 864) bzw. dem Nudge-
Befehl (siehe „Verschieben von Clips mit der 
Nudge-Funktion“ auf Seite 607) erfolgen.

Das Trim-Tool kann auch für MIDI-Clips 
verwendet werden. Weitere Informationen 
finden Sie unter „Time Compression/
Expansion Trim-Tool-Funktionalität bei 
MIDI-Clips“ auf Seite 711.

Ändern der Endpunkte von Noten mit dem Trim-Tool
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Wenn der Edit-Modus auf „Grid“ eingestellt ist, 
wird der verschobene Anfangs- oder Endpunkt 
automatisch am nächstgelegenen Rasterpunkt 
ausgerichtet. Wenn der Edit-Modus auf „Spot“ 
eingestellt ist, öffnet sich das Spot-Dialogfeld, 
in das Sie die neue Position des Anfangs- bzw. 
Endpunkts der Note eingeben können.

Noten können auch mit dem Trim Clip to Selection-
Befehl (siehe „Trim To Selection-Befehl“ auf 
Seite 604) bzw. dem Trim To Insertion-Befehl (siehe 
„Trimmen mit der Nudge-Funktion“ auf Seite 606) 
getrimmt werden.

Trimmen von MIDI-Noten 
mit der Nudge-Funktion
Sie können Start- und Endpunkt selektierter MIDI-
Noten auch um den aktuellen Nudge-Wert trimmen.

So trimmen Sie den Start- oder Endpunkt 
selektierter MIDI-Noten um den Nudge-Wert:

1 Konfigurieren Sie den Nudge-Wert (siehe 
„Festlegen des Nudge-Werts“ auf Seite 607).

2 Selektieren Sie mit dem Time Grabber-Tool die 
MIDI-Noten, die Sie trimmen möchten.

3 Sie haben folgende Möglichkeiten:

• Halten Sie die Alt-Taste (Windows) bzw. Wahltaste 
(Mac) gedrückt und drücken Sie gleichzeitig die 
Plus- (+) oder Minus-Taste (–) auf dem Ziffernblock, 
um den Startpunkt der ausgewählten MIDI-Noten 
um den Nudge-Wert zu trimmen.

• Halten Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und drücken Sie 
gleichzeitig die Plus- (+) oder Minus-Taste (–) 
auf dem Ziffernblock, um den Endpunkt der 
ausgewählten MIDI-Noten um den Nudge-Wert 
zu trimmen.

Transponieren von MIDI-Noten 
mit der Nudge-Funktion
Sie können ausgewählte MIDI-Noten in 
Halbtonschritten transponieren, indem Sie die 
Plus- (+) oder Minus-Taste (–) auf dem 
Ziffernblock drücken.

So transponieren Sie die ausgewählten MIDI-
Noten in Halbtonschritten:

1 Selektieren Sie mit dem Time Grabber-Tool die 
MIDI-Noten, die Sie transponieren möchten.

2 Sie haben folgende Möglichkeiten:

• Halten Sie die Windows-Taste (Windows) bzw. 
die Befehlstaste (Mac) gedrückt und drücken Sie 
die Plus-Taste (+) auf dem Ziffernblock, um die 
ausgewählten MIDI-Noten um einen Halbton 
nach oben zu transponieren.

• Halten Sie die Windows-Taste (Windows) bzw. 
die Befehlstaste (Mac) gedrückt und drücken Sie 
die Minus-Taste (–) auf dem Ziffernblock, 
um die ausgewählten MIDI-Noten um einen 
Halbton nach unten zu transponieren.

Separieren von MIDI-Noten
Der Separate-Befehl ermöglicht Ihnen das 
Separieren von MIDI-Noten an der Position des Edit-
Cursors oder den Grenzen der Edit-Selektion. In der 
Notendarstellung im Edit-Fenster und in den MIDI 
Editor-Fenstern werden beim Separieren von MIDI-
Clips neue MIDI-Noten, aber keine neuen MIDI-Clips 
erstellt. In der Clips-Darstellung im Edit-Fenster 
hingegen werden beim Separieren von MIDI-Clips 
nur neue MIDI-Clips erstellt. Wenn die Edit-Selektion 
Audiospuren enthält, werden durch den Separate-
Befehl außerdem nur Clips auf MIDI- und 
Instrumentenspuren separiert, unabhängig von der 
Einstellung der Spurdarstellung.

Wenn der Grid-Modus aktiviert ist, 
können Sie ihn mithilfe der Strg-Taste 
(Windows) bzw. der Befehlstaste (Mac) 
vorübergehend deaktivieren.
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So separieren Sie MIDI-Noten an der Position 
des Edit-Cursors oder an den Grenzen der 
Edit-Selektion:

1 Erstellen Sie eine Edit-Selektion oder platzieren 
Sie den Edit-Cursor an der Position, an der Sie 
eine oder mehrere MIDI-Noten separieren 
möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Separate > At Selection.

• Klicken Sie mit der rechten Maustaste in den 
Notes-Fensterbereich und wählen Sie Separate.

So separieren Sie MIDI-Noten am Raster:

1 Legen Sie den Rasterwert fest.

2 Erstellen Sie eine Edit-Selektion oder ziehen 
Sie eine Fadenkreuz-Selektion, die die MIDI-
Noten enthält, die Sie trennen möchten.

3 Wählen Sie Edit > Separate > On Grid.

4 Klicken Sie im Pre-Separate Amount-
Dialogfeld auf OK.

Tools zum Separieren und 
Zusammenfassen von MIDI-Noten
In der Notendarstellung im Edit-Fenster und in MIDI 
Editor-Fenstern können sowohl das Pencil-Tool als 
auch die Grabber-Tools zum Separieren und 
Zusammenfassen von MIDI-Noten verwendet 
werden. 

Als Cursor-Symbole werden ein Messer für das 
Tool zum Separieren und ein Verband für das Tool 
zum Zusammenfassen angezeigt.

So separieren Sie eine MIDI-Note mit dem 
Separate-Tool:

 Wählen Sie das Grabber- oder Pencil-Tool aus 
und klicken Sie bei gedrückter Windows- und 
Umschalttaste (Windows) oder Ctrl- und 
Umschalttaste (Mac) auf die MIDI-Note an der 
Stelle, an der Sie separieren möchten.

So fassen Sie MIDI-Noten mit dem Consolidate-
Tool zusammen:

 Wählen Sie das Grabber- oder Pencil-Tool aus 
und klicken Sie bei gedrückter Windows- und 
Umschalttaste (Windows) oder Ctrl- und 
Umschalttaste (Mac) zwischen die separierten 
MIDI-Noten.

Separieren Sie MIDI-Noten an der Selektion, 
indem Sie Strg + E (Windows) bzw. 
Befehl + E (Mac) drücken.

Eine mithilfe des Separate-Tools zweigeteilte MIDI-
Note

Zusammenfassen von MIDI-Noten mithilfe des 
Consolidate-Tools
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Zusammenfassen von MIDI-Noten
Mit dem Consolidate-Befehl können Sie mehrere 
aufeinanderfolgende MIDI-Noten derselben Tonhöhe 
in einer einzelnen MIDI-Note zusammenfassen.

So fassen Sie MIDI-Noten zusammen:

1 Selektieren Sie die gewünschten MIDI-Noten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Consolidate.

• Klicken Sie mit der rechten Maustaste auf die 
ausgewählten Noten und wählen Sie Consolidate.

Stummschalten von MIDI-Noten
Mit dem Mute-Befehl können Sie einzelne MIDI-
Noten stummschalten. Wenn komplette Clips 
selektiert wurden, werden Sie bei Verwendung des 
Mute-Befehls gefragt, ob Sie Clips oder MIDI-
Noten stummschalten möchten.

So schalten Sie eine oder mehrere MIDI-Noten 
stumm:

1 Selektieren Sie die gewünschten MIDI-Noten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Mute Notes.

• Klicken Sie mit der rechten Maustaste auf 
die selektierten MIDI-Noten und wählen Sie 
Mute Notes.

So heben Sie die Stummschaltung für eine oder 
mehrere MIDI-Noten wieder auf:

1 Selektieren Sie die gewünschten MIDI-Noten, 
für die Sie die Stummschaltung 
aufheben möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Unmute Notes.

• Klicken Sie mit der rechten Maustaste auf die 
selektierten MIDI-Noten und wählen Sie 
Unmute Notes.

Manuelles Bearbeiten der 
Velocity-Werte von Noten
Wenn für eine MIDI- oder Instrumentenspur die 
Velocity-Darstellung eingestellt ist oder die Velocity-
Lane unter einer Spur angezeigt wird, wird die 
Attack-Velocity jeder Note mit einem Velocity-
Balken dargestellt. Je länger der Velocity-Balken, 
desto höher ist der Velocity-Wert (0–127).

So bearbeiten Sie die MIDI-Velocity im Edit-
Fenster:

1 Sie haben folgende Möglichkeiten:

• Zeigen Sie die MIDI- oder Instrumentenspur in 
der Velocity-Darstellung an.

• Zeigen Sie die Controller-Lane für die MIDI- 
oder Instrumentenspur sowie die Velocity an.

2 Wählen Sie ein Grabber-Tool.

Drücken Sie Alt + Umschalt + 3 (Windows) 
bzw. Wahl + Umschalt + 3 (Mac), 
um benachbarte ausgewählte MIDI-Noten 
derselben Tonhöhe zusammenzuführen.

Drücken Sie Strg + M (Windows) bzw. 
Befehl + M (Mac), um selektierte MIDI-
Noten stummzuschalten bzw. die 
Stummschaltung aufzuheben.

Anzeigen der Velocity-Lane
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3 Ziehen Sie die Spitze des Velocity-Balkens 
(Raute) nach oben oder unten.

Die Velocity-Werte eines Notenbereichs können 
mit einem Pencil-Tool bearbeitet werden.

So zeichnen Sie Velocity-Werte für ein Crescendo:

1 Sie haben folgende Möglichkeiten:

• Zeigen Sie die MIDI- oder Instrumentenspur in 
der Velocity-Darstellung an.

• Zeigen Sie die Controller-Lane für die MIDI- 
oder Instrumentenspur sowie die Velocity an.

2 Wählen Sie das Pencil-Tool in der Line-
Form aus.

3 Klicken Sie möglichst weit unten im Bereich 
der Velocity-Werte auf den Beginn der 
Notenfolge und ziehen Sie den Cursor nach 
rechts oben, bis die Linie alle Noten umfasst, 
die im Fade einschlossen werden sollen.

Außerdem können Sie das Trim-Tool verwenden, 
um die Velocity-Werte für alle selektierten Noten 
zu skalieren. Es ist besonders dann nützlich, wenn 
Sie die Relationen zwischen den Velocity-Werten 
der einzelnen Noten erhalten möchten, die Noten 
insgesamt aber etwas lauter oder leiser klingen 
sollen.

So skalieren Sie Velocity-Werte mit dem Trim-Tool:

1 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Velocity-Darstellung an.

2 Selektieren Sie mit dem Selector-Tool oder 
einem Grabber-Tool die zu editierende 
Notenfolge.

3 Klicken Sie mit dem Trim-Tool in der Nähe des 
selektierten Notenbereichs und ziehen Sie nach 
oben oder unten. Ziehen nach oben erhöht die 
Velocity-Werte der einzelnen Noten, Ziehen 
nach unten verringert sie.

Velocity Trim-Tool

So trimmen Sie die Velocity einer oder mehrerer 
selektierter MIDI-Noten:

 Klicken Sie mit aktiviertem Grabber-Tool bei 
gedrückter Strg-Taste (Windows) oder 
Befehlstaste (Mac) auf die Note und ziehen Sie 
noch oben bzw. unten. Aus dem Grabber-Tool 
wird das Velocity Trim-Tool.

Ziehen eines Velocity-Balkens

Ändern von Velocity-Werten mit der Line-Form

Sie können das Trim-Tool in der Velocity-
Darstellung neben der Velocity-Änderung auch 
zum Trimmen der Notendauer verwenden.

Ändern von Velocity-Werten mit dem Trim-Tool

Editieren übereinander liegender Velocity-Werte
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Ziehen Sie die Spitze des Balkens nach oben, 
um den Velocity-Wert zu erhöhen, oder nach 
unten, um ihn zu verringern. Während Sie ziehen, 
ändert sich die Anzeigefarbe der Balkenspitze 
(Raute) zu blau und die dazugehörige Note wird 
selektiert. Die jeweiligen Velocity-Werte werden 
in der Cursorpositionswert-Anzeige im Edit-
Fenster angezeigt.

Abhören von Änderungen 
der Velocity-Werte
Wenn die Option „Play MIDI Notes When 
Editing“ aktiviert ist, gibt Pro Tools bei der 
Bearbeitung von Velocity-Werten für MIDI-Noten 
mit dem Grabber-Tool die Note mit dem neuen 
Velocity-Wert wieder. Auf diese Weise können 
Sie hören, wann Sie die für eine MIDI-Note 
gewünschte Velocity-Einstellung erreicht haben.

Eingeben von Notenattributen
Wenn eine einzelne Note mit dem Pencil-Tool 
oder einem Grabber-Tool selektiert wird, werden 
ihre Attribute im Event Edit-Bereich angezeigt.

Die Tonhöhe wird durch die Notenbezeichnung 
und die Oktavlage angezeigt. Attack- und Release-
Velocity-Werte werden durch die entsprechenden 
MIDI-Werte (0–127) angezeigt. Start, Ende und 
Länge der Edit-Selektion werden in der Haupt-
Zeitskala angezeigt.

So ändern Sie die Attribute einer MIDI-Note:

1 Zeigen Sie im Edit-Fenster eine MIDI- oder 
Instrumentenspur in der Notendarstellung an. 
Wählen Sie dann die Note mit dem Pencil-Tool 
oder einem Grabber-Tool aus.

2 Klicken Sie im Event Edit-Bereich auf das 
Textfeld für ein Attribut und wählen Sie eine 
der folgenden Vorgehensweisen:

• Geben Sie den neuen Wert über den 
Ziffernblock ein.

• Verwenden Sie die Pfeiltaste nach oben oder 
nach unten, um zum neuen Wert zu springen.

• Ziehen Sie nach oben oder unten, um zum neuen 
Wert zu gelangen. 

• Spielen Sie den neuen Notenwert auf dem 
MIDI-Keyboard-Controller ab.

Drücken Sie die Schrägstrich-Taste (/), 
um zwischen den verschiedenen Anzeigefeldern 
im Event Edit-Bereich zu wechseln.

Wenn zwei Noten denselben Anfangspunkt 
aufweisen (die Velocity-Balken liegen 
übereinander), ziehen Sie die eigentliche 
Note bei gedrückter Strg-Taste (Windows) 
oder Befehlstaste (Mac) nach oben bzw. 
unten, um den Velocity-Wert anzupassen.

Event Edit-Bereich mit Informationen zur MIDI-Spur 

Pitch
Attack-Velocity

Release-Velocity

Sie können die Attribute von MIDI-Noten 
auch in der MIDI Event-Liste ändern (siehe 
Kapitel 34: „MIDI Event-Liste“).
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Editieren mehrerer Noten im 
Event Edit-Bereich
Wenn mehrere Noten selektiert werden, wirken 
sich die in die Felder im Event Edit-Bereich 
eingegebenen Werte auf alle selektierten Noten 
aus. Ein Dreieck (Deltasymbol) links neben der 
gespielten Note weist darauf hin, dass mehrere 
Noten selektiert wurden.

Durch Eingabe eines neuen Werts im Start-Feld 
wird die erste Note der Selektion an diesem Punkt 
positioniert und alle weiteren Noten werden 
ebenfalls verschoben.

Die in die Anzeigefelder für Tonhöhe und Velocity 
eingegebenen Werte werden zum Wert jeder 
selektierten Note addiert oder von ihm subtrahiert. 
Um also etwa alle selektierten Noten um eine 
Oktave nach unten zu transponieren, geben Sie für 
die Tonhöhe den Wert –12 ein.

Löschen von MIDI-Noten
Selektierte Noten können mit dem Clear-Befehl im 
Edit-Menü gelöscht werden. Darüber hinaus haben 
Sie die Möglichkeit, selektierte Noten mit dem 
Pencil-Tool zu löschen.

So löschen Sie eine Gruppe von MIDI-Noten 
mit dem Clear-Befehl:

1 Selektieren Sie mit dem Grabber- oder Selector-
Tool die zu löschenden Noten (siehe 
„Selektieren von MIDI-Noten“ auf Seite 700).

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Clear, um die selektierten 
Noten zu löschen. Die der Spur zugewiesenen 
Controller-Daten bleiben unverändert.

• Klicken Sie mit einem beliebigen Edit-Tool mit 
der rechten Maustaste auf eine selektierte Note 
und wählen Sie Clear.

• Drücken Sie die Rücktaste (Windows) bzw. 
die Entf-Taste (Mac).

So löschen Sie eine einzelne MIDI-Note mit dem 
Pencil-Tool:

 Klicken Sie mit dem Pencil-Tool bei gedrückter 
Alt-Taste (Windows) oder Wahltaste (Mac) auf 
die Note. Aus dem Pencil-Tool wird ein Eraser-
Tool, wenn die Alt-Taste (Windows) bzw. 
die Wahltaste (Mac) gedrückt wird.

Editieren mehrerer Noten im Event Edit-Bereich

Wenn Sie MIDI-Noten innerhalb eines 
selektierten Zeitbereichs löschen, werden 
gleichzeitig auch alle zugewiesenen Controller- 
und Automation-Daten gelöscht.

Löschen einer Note mit dem Pencil-Tool

Program Change- und Sysex-Events können 
ebenfalls durch Klicken mit dem Pencil-Tool 
bei gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac) gelöscht werden.
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Time Compression/
Expansion Trim-Tool-
Funktionalität bei MIDI-Clips
Das Time Compression/Expansion Trim-Tool ist 
hilfreich beim Anpassen eines MIDI-Clips an die 
Länge eines anderen Clips, an ein Temporaster oder 
an einen beliebigen anderen Referenzpunkt.

Mit dem Time Compression/Expansion Trim-Tool 
können Sie den Start- oder Endpunkt des MIDI-
Clips verschieben, um den Clip zu dehnen oder zu 
komprimieren und die MIDI-Daten dabei 
entsprechend zu skalieren – unabhängig von der 
Zeitbasis der Spur (Ticks oder Samples).

Verwenden des Time 
Compression/Expansion Trim-
Tools im Grid-Modus
Das Time Compression/Expansion Trim-Tool 
(TCE Trim-Tool) kann im Grid-Modus dazu 
verwendet werden, das Audiomaterial eines Clips 
an das Tempo einer Session oder eines Session-
Abschnitts anzupassen sowie Wiedergaben in der 
doppelten oder halben Dauer zu erstellen.

So komprimieren oder dehnen Sie MIDI-Clips im 
Grid-Modus:

1 Setzen Sie den Edit-Modus auf „Grid“.

2 Zeigen Sie ggf. die MIDI- oder Instrumentenspur 
in der Clips-Darstellung an.

3 Wählen Sie das TCE Trim-Tool.

4 Verschieben Sie den Start- oder Endpunkt des 
MIDI-Clips mit dem TCE Trim-Tool, um den 
Clip entsprechend dem Raster (etwa um 
Viertelnoten) zu komprimieren oder zu dehnen. 
Ein neuer MIDI-Clip wird automatisch erstellt 
und in der Playlist sowie der Clipliste angezeigt.

Verwenden des Time 
Compression/Expansion 
Trim-Tools im Slip-Modus

So komprimieren oder dehnen Sie MIDI-Clips im 
Slip-Modus:

1 Setzen Sie den Edit-Modus auf „Slip“.

2 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Clips-Darstellung an.

3 Wählen Sie das TCE Trim-Tool.

4 Verschieben Sie den Start- oder Endpunkt des 
MIDI-Clips mit dem TCE Trim-Tool, um den 
Clip beliebig zu komprimieren oder zu dehnen. 
Ein neuer MIDI-Clip wird automatisch erstellt 
und in der Playlist sowie der Clipliste angezeigt.

Verwenden des Time 
Compression/Expansion 
Trim-Tools im Spot-Modus
Wenn Sie im Spot-Modus mit dem TCE-Trim-
Tool auf einen Clip klicken, wird das Spot-
Dialogfeld geöffnet. Sie können den Start- oder 
Endpunkt des Clips oder seine Länge festlegen, 
und der Clip wird automatisch wie angegeben 
komprimiert oder gedehnt.

Vor dem Trimmen eines MIDI-Clips mit dem Time 
Compression/Expansion Trim-Tool

Nach dem Trimmen eines MIDI-Clips mit dem Time 
Compression/Expansion Trim-Tool
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So komprimieren oder dehnen Sie MIDI-Clips 
im Spot-Modus:

1 Setzen Sie den Edit-Modus auf „Spot“.

2 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Clips-Darstellung an.

3 Wählen Sie das TCE Trim-Tool.

4 Klicken Sie in der Nähe des Start- oder 
Endpunkts auf den MIDI-Clip. Das Spot-
Dialogfeld wird geöffnet. Geben Sie unter 
Verwendung einer beliebigen Zeitskala einen 
neuen Start- oder Endpunkt (bzw. eine neue 
Länge) für den Clip ein und klicken Sie dann 
auf „OK“. Ein neuer MIDI-Clip wird 
automatisch erstellt und in der Playlist sowie 
der Clipliste angezeigt.

Verwenden des Time 
Compression/Expansion 
Trim-Tools im Shuffle-Modus
Im Shuffle-Modus beginnt der getrimmte Clip 
immer am Startpunkt des ursprünglichen Clips, 
unabhängig davon, ob Sie den Clip von vorne nach 
hinten oder von hinten nach vorne trimmen.

So komprimieren oder dehnen Sie MIDI-Clips im 
Shuffle-Modus:

1 Setzen Sie den Edit-Modus auf „Shuffle“.

2 Zeigen Sie die MIDI- oder Instrumentenspur in 
der Clips-Darstellung an.

3 Wählen Sie das TCE Trim-Tool.

4 Verschieben Sie den Start- oder Endpunkt des 
MIDI-Clips mit dem Time Compression/
Expansion Trim-Tool, um den Clip beliebig zu 
komprimieren oder zu dehnen. Ein neuer MIDI-
Clip wird automatisch erstellt und in der 
Playlist sowie der Clipliste angezeigt.

Continuous Controller-Events
Continuous Controller-Events werden auf MIDI- 
und Instrumentenspuren in Form einer Linie 
grafisch dargestellt und können über sogenannte 
Breakpoints bearbeitet werden. Die Breakpoints auf 
MIDI- und Instrumentenspuren stehen dabei jeweils 
für ein bestimmtes Controller-Event. Controller-
Events auf MIDI-Spuren unterscheiden sich von 
Automation-Daten auf Audiospuren durch die 
gebotene Auflösung, da ihre Werte nur schrittweise 
verändert werden können. 

Führen Sie einen der folgenden Schritte aus, 
um MIDI-Controller-Daten für eine Spur 
anzuzeigen:

 Wählen Sie im Track View-Menü 
die entsprechende Spurdarstellung.

 Zeigen Sie die entsprechende MIDI-Controller-
Lane unter der Spur an.

Instrumentenspur mit MIDI-Lautstärke-Events in der 
MIDI Volume-Darstellung

Instrumentenspur mit MIDI-Volume-Lane

Controller-Typ-Selektor

Controller-Lanes anzeigen
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Folgende Continuous Controller-Events können in 
Pro Tools eingefügt und bearbeitet werden:

• Lautstärke

• Pan

• Pitch Bend

• Aftertouch (Mono)

• MIDI-Controller, 0–127

MIDI-Controller 7 (Lautstärke) und 10 (Pan) werden 
in Pro Tools als Automation-Daten behandelt. Dies 
bedeutet, dass diese Controller-Events (ebenso wie 
die Stummschaltung) vom Mix-Fenster aus 
aufgenommen und automatisiert werden können. 
Außerdem hängt die Art und Weise, wie diese 
Events abgespielt und aufgenommen werden, 
vom Automation-Modus der jeweiligen MIDI- 
oder Instrumentenspur ab. Während die Lautstärke-, 
Pan-und Stummschaltungs-Events einer MIDI-Spur 
ausgesetzt werden können, werden alle anderen 
Controller-Events der MIDI-Spur stets 
wiedergegeben. Instrumentenspuren unterstützen 
sowohl Lautstärke-, Pan- und Stummschaltungs-
Events sowohl in MIDI- als auch in Audioform.

Um das Überschreiben bestehender Automation-
Daten für MIDI-Lautstärke und Pan zu verhindern, 
wählen Sie für die Aufnahme den MIDI Merge-
Modus. Bei der Aufnahme im MIDI Merge-Modus 
werden bestehende Lautstärke- und Pan-Daten 
während der Aufnahme neuer MIDI-Daten 
wiedergegeben. 

Continuous Controller-Events (einschließlich 
Lautstärke und Pan) können von einem externen 
MIDI-Controller (wie etwa einem Keyboard oder 
einer sonstigen Bedienoberfläche) aufgenommen 
werden, und sie können mit dem Pencil-Tool oder 
einem Grabber-Tool in die Playlist einer MIDI-
Spur eingefügt werden.

Einfügen und Bearbeiten 
von Controller-Events
Continuous Controller-Events können 
folgendermaßen bearbeitet werden:

 Durch Ziehen mit einem Grabber kann die 
Position bzw. der Wert jedes einzelnen 
Breakpoints angepasst werden.

 Eine Gruppe ausgewählter Breakpoints kann 
mit einem der Trim-Tools vergrößert oder 
verkleinert werden.

 Neue Controller-Events können mit dem Pencil-
Tool eingezeichnet werden, um vorhandene Events 
zu ersetzen. Events können mit dem Pencil-Tool (als 
„Free Hand“, „Line“, „Triangle“, „Square“ oder 
„Random“) gezeichnet werden.

 Controller-Events können ausgeschnitten oder 
kopiert und eingefügt werden sowie mit und ohne 
Nudge-Funktion verschoben werden.

Polyphone Aftertouch-Daten werden im Edit-
Fenster nicht angezeigt. Um polyphonen 
Aftertouch in Pro Tools anzuzeigen, verwenden 
Sie die MIDI Event-Liste (siehe Kapitel 34: 
„MIDI Event-Liste“).

Um Continuous MIDI-Controller-Events zu 
kopieren und in einen anderen MIDI-
Controller einzufügen, verwenden Sie „Edit > 
Paste Special > To Current Automation 
Type“. Es kann etwa vorkommen, dass Sie 
dieselben Steuerungsdaten für die Lautstärke 
und einen Cut-Off-Filter oder für Pan und 
Pitch Bend verwenden möchten. Weitere 
Informationen finden Sie unter „Special 
Paste-Funktion für Automationsdaten“ auf 
Seite 1109.
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Einstellen der Auflösung von 
eingefügten Controller-Events
Wenn Sie Controller-Events mit dem Pencil-Tool 
einfügen, hängt die Anzahl der Events von der 
Einstellung für Pencil Tool Resolution When 

Drawing Controller Data (auf der MIDI 
Preferences-Registerkarte) ab.

So stellen Sie die Auflösung des Pencil-Tools ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie anschließend auf die MIDI-Registerkarte.

2 Geben Sie einen Wert (von 1 bis 100 
Millisekunden) für Pencil Tool Resolution 

When Drawing Controller Data ein. 

3 Klicken Sie auf OK.

Wenn Sie ein Continuous Controller-Event mit 
dem Pencil-Tool bearbeiten möchten, müssen Sie 
den Controller zuerst der Automated MIDI 
Controllers-Liste hinzufügen.

So aktivieren Sie einen Continuous Controller 
manuell für die Automation: 

1 Sie haben folgende Möglichkeiten:

• Klicken Sie auf den Track View-Selektor für die 
zu editierende MIDI- oder Instrumentenspur und 
wählen Sie im Controllers-Untermenü die Option 
„Add/Remove Controllers“.

• Wenn Controller-Lanes unter der MIDI- oder 
Instrumentenspur angezeigt werden, den Sie 
editieren möchten, klicken Sie auf den Controller-
Typ-Selektor für die Controller-Lane unter der 
Spur und wählen Sie im Controllers-Untermenü 
die Option „Add/Remove Controllers“.

Änderungen an Lautstärkedaten wirken sich auf 
alle Spuren innerhalb einer aktivierten Edit-
Gruppe aus. Für andere Controller-Playlists 
(wie etwa „Pan“) gilt dies jedoch nicht. 
Um andere Controller-Typen in allen Spuren 
einer Edit-Gruppe einzufügen oder zu 
bearbeiten, halten Sie die Windows-Taste 
(Windows) bzw. die Ctrl-Taste (Mac) gedrückt, 
während Sie die Änderungen vornehmen.

Wenn Sie Controller-Informationen von 
einem externen Gerät aufnehmen, wird der 
Controller automatisch der Automated MIDI 
Controllers-Liste hinzugefügt.

Aktivieren der Option „Add/Remove Controllers“ über 
den Track View-Selektor

Auswählen von „Add/Remove Controllers“ aus dem 
Controller-Typ-Selektor für eine Controller-Lane



Kapitel 31: Editieren von MIDI-Daten 715

2 Wählen Sie im Automated MIDI Controllers-
Dialogfeld den MIDI-Controller-Bereich für den 
Controller, den Sie automatisieren möchten. 

3 Wählen Sie den zu automatisierenden Controller 
in der Liste links aus und klicken Sie auf Add. 
Der ausgewählte Controller wird der Automated 
MIDI Controllers-Liste rechts hinzugefügt.

4 Wiederholen Sie ggf. die Schritte 2 und 3, 
bis Sie alle MIDI-Controller hinzugefügt 
haben, die Sie für die Automation benötigen.

5 Um einen Controller aus der Automated MIDI 
Controllers-Liste zu entfernen, wählen Sie ihn 
in der Liste rechts aus und klicken Sie auf 
Remove.

6 Klicken Sie auf OK, um das Automated MIDI 
Controllers-Dialogfeld zu schließen.

Patch Select-Dialogfeld 
(Program und Bank Changes)
Für jede MIDI- und Instrumentenspur kann ein 
Standard-Program Change definiert werden, 
der bei jeder Wiedergabe der Spur gesendet wird. 
Zusätzliche Program Changes können an jeder 
beliebigen Position der Spur eingefügt werden.

Informationen zu Program und 
Bank Changes
Das MIDI-Protokoll ermöglicht Ihnen die Auswahl 
aus insgesamt 128 MIDI-Programmen (0–127). 
Die meisten MIDI-Instrumente verfügen jedoch über 
mehrere sogenannte Banks mit jeweils 128 
Programmen. Zum Angeben einer Bank muss ein 
Bank Select-Befehl gesendet werden. Manche 
Instrumente verwenden den Controller 0, um 
zwischen den Banks umzuschalten, andere hingegen 
Controller 32; auch eine Kombination aus beiden ist 
möglich. Im Patch Select-Dialogfeld von Pro Tools 
können Sie wählen, welchen dieser Bank Select-
Befehle Sie verwenden möchten, wenn Sie ein 
Program Change-Event einfügen. Informationen zum 
verwendeten Controller-Wert finden Sie in der 
Hersteller-Dokumentation zu Ihrem MIDI-Gerät.

Auswählen des MIDI-Controller-Bereichs

Automated MIDI Controllers-Dialogfeld

Wenn Sie Continuous Controller-Informationen 
von einem externen MIDI-Gerät aufnehmen, 
wird der Controller automatisch der MIDI 
Controllers-Liste hinzugefügt.

Program Changes werden an externe 
MIDI-Geräte gesendet. Instrumenten-
Plug-Ins in Pro Tools reagieren nicht auf 
Program Change-Informationen.
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Standard-Program Change
Der Standard-Program Change jeder MIDI-Spur 
wird über die Patch Select-Schaltfläche im Edit- 
oder Mix-Fenster eingestellt. Einmal eingestellt, 
wird dieser Program Change-Befehl immer dann 
an das angeschlossene Instrument gesendet, wenn 
die entsprechende Spur wiedergegeben wird.

So legen Sie den Standard-Program Change für 
eine MIDI- oder Instrumentenspur fest:

1 Klicken Sie im Mix- oder Edit-Fenster auf 
„Patch Select“.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie im Patch Select-Dialogfeld eine 
Programmnummer aus.

• Wählen Sie bei Verwendung von Patch-
Namendateien einen Patch-Namen (siehe 
„MIDI-Patch-Namen“ auf Seite 717).

3 Klicken Sie auf Done.

Einmal ausgewählt, erscheint die 
Programmnummer (oder der Patch-Name) auf der 
Patch Select-Schaltfläche im Edit-Fenster.

Wenn Sie nicht sicher sind, welchen Bank 
Select-Befehl Ihr Instrument benutzt, können 
Sie MIDI in Pro Tools aufnehmen, während Sie 
einen Bank Change auf dem Instrument 
ausführen. Überprüfen Sie anschließend die 
Bank Select-Informationen, die von Ihrem 
Instrument in der MIDI Event-Liste von 
Pro Tools aufgezeichnet wurden.

Einige ältere MIDI-Geräte (wie der Kurzweil 
K1000) verwenden statt eines Bank Select-
Befehls einen Program Change zum 
Umschalten zwischen Banks. Bei diesen 
Geräten kann es erforderlich sein, zwei 
Program Change-Befehle zu senden, um ein 
bestimmtes Programm auszuwählen: Mit 
dem ersten Befehl wird die Bank festgelegt, 
mit dem zweiten das Programm.

Patch Select-Schaltflächen

Patch Select-Dialogfeld
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Im Gegensatz zu aufgenommenen und eingefügten 
Program Changes erscheint der Standard-Program 
Change nicht in der Playlist der jeweiligen Spur.

Um den Standard-Program Change zu löschen, 
wählen Sie im Patch Select-Dialogfeld die Option 
None.

MIDI-Patch-Namen
Pro Tools unterstützt XML (Extensible Markup 
Language) zum Speichern und Importieren von 
Patch-Namen für externe MIDI-Geräte (etwa 
MIDI-Instrumente). In Pro Tools werden MIDI-
Patch-Namendateien (.midnam) für die 
werkseitigen Standard-Patch-Namen vieler 
gängiger MIDI-Geräte installiert.

Auf dem Mac befinden sich diese Dateien in /
Library/Audio/MIDI Patch Names/Avid. 

Unter Windows befinden sich diese Dateien in 
„Programme\Gemeinsame Dateien\Avid\ 
Pro Tools\MIDI Patch Names\“.

So importieren Sie MIDI-Patch-Namen in Pro Tools:

1 Wählen Sie Setup > MIDI > MIDI Studio.

2 Führen Sie je nach Computerplattform einen 
der folgenden Schritte aus:

• Mac: Überprüfen Sie den MIDI-Gerätenamen 
im MIDI Studio-Fenster (siehe „MIDI-Studio-
Setup (Mac)“ auf Seite 145).

• Windows: Überprüfen Sie den MIDI-
Gerätenamen im MIDI Studio Setup-Fenster 
(siehe „MIDI-Studio-Setup (Windows)“ auf 
Seite 148).

3 Überprüfen Sie, ob der Ausgang der 
Instrumenten- oder MIDI-Spur dem MIDI-
Gerät korrekt zugewiesen ist.

4 Klicken Sie auf die Patch Select-Schaltfläche 
der Instrumenten- oder MIDI-Spur.

Patch Select-Schaltfläche im Edit-Fenster

MIDI-Patch-Namendateien (.midnam) 
können in jedem beliebigen Texteditor 
bearbeitet werden. Sie können auch Patch-
Librarian- und Editorsoftware von 
Drittherstellern verwenden, um eigene 
Patch-Namen zu erstellen.

Weitere Informationen zum Konfigurieren von 
MIDI auf Windows- und Mac-Systemen finden 
Sie in Kapitel 10: „MIDI-Konfiguration“.

Patch Select-Schaltfläche im Edit-Fenster

Patch Select-Schaltfläche im Mix-Fenster
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5 Klicken Sie im Patch Select-Dialogfeld auf 
Change.

6 Führen Sie im Open-Dialogfeld einen der 
folgenden Schritte aus:

• Auf dem Mac navigieren Sie zu „/Library/
Audio/MIDI Patch Names/Avid/<Name des 
Herstellers>“ und wählen Sie die MIDI-Patch-
Namendatei (.midnam) für das MIDI-Gerät.

• Unter Windows navigieren Sie zu 
„Programme\Gemeinsame Dateien\Avid\ 
Pro Tools\MIDI Patch Names\<Name des 
Herstellers>“ und wählen Sie die MIDI-Patch-
Namensdatei (.midnam) für das MIDI-Gerät.

7 Wählen Sie die MIDI-Patch-Namendatei 
(.midnam) für das MIDI-Gerät aus.

8 Klicken Sie auf Open. Im Patch Select-
Dialogfeld sind die Patch-Namen der 
ausgewählten Datei aufgeführt.

9 Wählen Sie für MIDI-Geräte mit mehreren 
Patch-Banks im Bank-Popup-Menü die 
gewünschte Patch-Bank aus.

Nach dem Import von Patch-Namen in Pro Tools 
sind diese für das MIDI-Gerät in allen Sessions 
verfügbar.

So löschen Sie Patch-Namen:

1 Klicken Sie im Patch Select-Dialogfeld auf 
Clear.

2 Klicken Sie auf Done.

Patch Select-Dialogfeld

Change-Schaltfläche

Patch Select-Dialogfeld mit Patch-Namen

Auswählen einer Bank im Patch Select-Dialogfeld
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Einfügen und Editieren von 
Program Changes
Program Changes können mit dem Pencil-Tool in 
die Playlist einer Spur eingefügt werden. Bereits 
vorhandene Program Changes können editiert, 
verschoben sowie kopiert und eingefügt werden.

So fügen Sie einen Program Change mit dem 
Pencil-Tool ein:

1 Sie haben folgende Möglichkeiten: 

• Zeigen Sie die MIDI- oder Instrumentenspur in 
der Program Change-Darstellung an.

• Zeigen Sie die Controller-Lane für die MIDI- 
oder Instrumentenspur sowie den Program 
Change an.

2 Wenn das eingefügte Event am Rasterwert 
ausgerichtet werden soll, aktivieren Sie den 
Grid-Modus. 

3 Klicken Sie mit dem Pencil-Tool in der Playlist 
der Spur an die Stelle, an der der Program 
Change eingefügt werden soll.

4 Wählen Sie im Patch Select-Dialogfeld die 
Nummer (oder den Patch-Namen) des 
gewünschten Programms aus und geben Sie 
ggf. einen Bank Change-Wert an.

5 Klicken Sie auf Done, um das Program Change-
Event in die Playlist der Spur einzufügen.

So editieren Sie ein Program Change-Event:

1 Doppelklicken Sie mit dem Pencil-Tool oder 
einem Grabber-Tool auf das Program Change-
Event, das Sie editieren möchten.

2 Wählen Sie im Patch Select-Dialogfeld die 
Nummer oder den Namen des neuen 
Programms und geben Sie ggf. einen Bank 
Change-Wert an.

3 Klicken Sie auf Done.

So verschieben Sie ein Program Change-Event:

 Ziehen Sie das Program Change-Event mit dem 
Pencil-Tool oder einem Grabber-Tool nach 
links oder rechts.

Wenn der Edit-Modus auf „Grid“ eingestellt ist, 
wird das verschobene Event automatisch am 
nächstgelegenen Rasterpunkt ausgerichtet. Wenn 
der Edit-Modus auf „Spot“ eingestellt ist, öffnet 
sich das Spot-Dialogfeld.

Bei manchen Instrumenten können Program 
Changes während der Wiedergabe eine 
kurzzeitige Unterbrechung der 
Klangerzeugung bewirken. Um dies zu 
vermeiden, positionieren Sie Program 
Changes möglichst in Passagen, in denen 
sich keine MIDI-Noten befinden.

Program Change-Event

Die Positionierung von Program Changes 
kann auch mit dem Shift-Befehl (siehe „Shift-
Befehl“ auf Seite 864) bzw. dem Nudge-
Befehl (siehe „Verschieben von Clips mit der 
Nudge-Funktion“ auf Seite 607) erfolgen.
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So löschen Sie ein Program Change-Event:

1 Legen Sie die Spurdarstellung oder Controller-
Lane auf die Program Change-Darstellung fest 
und klicken Sie mit einem Grabber-Tool auf das 
Program Change-Event, um es zu selektieren.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Clear, um die selektierten 
Events aus der Spur zu entfernen.

• Drücken Sie die Rücktaste (Windows) bzw. 
die Entf-Taste (Mac).

Abhören von Programmen
Wenn das Patch Select-Dialogfeld geöffnet ist, 
kann Pro Tools automatisch durch die 
verschiedenen Patches eines der Spur 
zugewiesenen MIDI-Geräts scrollen.

So hören Sie Patches ab:

1 Wenn Sie Patches für eine MIDI- oder 
Instrumentenspur während der Wiedergabe 
abhören möchten, klicken Sie im Transport-
Fenster auf „Play“.

2 Öffnen Sie das Patch Select-Dialogfeld, indem 
Sie auf die Patch Select-Schaltfläche klicken 
oder ein Program Change-Event in eine MIDI- 
oder Instrumentenspur einfügen bzw. ein 
bestehendes editieren.

3 Klicken Sie auf die Nummer des Patches (oder 
den Patch-Namen), von dem an Sie durch die 
anderen Patches scrollen möchten.

4 Sie können einen Wert in Sekunden eingeben 
und damit die Zeit festlegen, die zwischen den 
einzelnen Program Changes liegen soll.

5 Aktivieren Sie die Increment Patch-Option.

Nach der angegebenen Anzahl von Sekunden 
schaltet Pro Tools zum jeweils nächsten Patch und 
sendet den entsprechenden Program Change an 
den der Spur zugewiesenen MIDI-Ausgang.

6 Wenn Sie das Abhören der Einstellungen 
abgeschlossen haben, deaktivieren Sie die 
Option Increment Patch, wählen Sie die 
gewünschte Programmnummer (oder den 
Patch-Namen) aus und klicken Sie auf Done.

Wenn der Clip andere Events enthält, die Sie 
löschen möchten, können Sie den Clip 
löschen. Dabei wird auch das Program 
Change-Event gelöscht.

Einzelne Program Change-Events können 
auch durch Klicken mit dem Pencil-Tool bei 
gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac) gelöscht werden.
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System Exclusive-Events
In Pro Tools können Sie System Exclusive-Events 
(Sysex) auf MIDI- oder Instrumentenspuren 
aufnehmen (siehe „MIDI Step Input“ auf Seite 494). 
Aufgezeichnete Events erscheinen in der Playlist der 
Spur als Blöcke, wenn die Spurdarstellung auf 
Sysex eingestellt ist oder eine auf Sysex eingestellte 
Controller-Lane angezeigt wird.

Während die Inhalte von aufgezeichneten 
systemexklusiven Events nicht direkt in Pro Tools 
bearbeitet werden können, können die Events 
selbst verschoben, kopiert und eingefügt sowie 
gelöscht werden.

So nehmen Sie ein Sysex-Event auf:

1 Erstellen Sie eine neue MIDI-Spur.

2 Legen Sie als Eingang für die MIDI-Spur den 
Anschluss fest, an den das MIDI-Gerät 
angeschlossen ist.

3 Konfigurieren Sie das MIDI-Gerät zum Senden 
von Sysex (wie etwa einen Bulk Dump).

4 Starten Sie im Transport-Fenster die Aufnahme.

5 Starten Sie die Sysex-Übertragung von Ihrem 
MIDI-Gerät.

6 Wenn die Sysex-Übertragung von Ihrem MIDI-
Gerät abgeschlossen ist, klicken Sie im 
Transport-Fenster auf „Stop“.

So verschieben Sie ein Sysex-Event:

1 Sie haben folgende Möglichkeiten: 

• Zeigen Sie die MIDI- oder Instrumentenspur in 
der Sysex-Darstellung an.

• Zeigen Sie die Controller-Lane für die MIDI- 
oder Instrumentenspur sowie „Sysex“ an.

2 Ziehen Sie das Sysex-Event mit einem Grabber 
nach links oder rechts.

Wenn der Edit-Modus auf „Grid“ eingestellt ist, 
wird das verschobene Event automatisch am 
nächstgelegenen Rasterpunkt ausgerichtet. Wenn 
der Edit-Modus auf „Spot“ eingestellt ist, öffnet 
sich das Spot-Dialogfeld.

So löschen Sie ein oder mehrere Sysex-Events:

1 Sie haben folgende Möglichkeiten: 

• Zeigen Sie die MIDI- oder Instrumentenspur in 
der Sysex-Darstellung an.

• Zeigen Sie die Controller-Lane für die MIDI- 
oder Instrumentenspur sowie „Sysex“ an.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Clear, um die selektierten 
Events aus der Spur zu entfernen.

• Drücken Sie die Rücktaste (Windows) bzw. die 
Entf-Taste (Mac).

Sysex-Event-Block in der Sysex-Darstellung

Um mit der Aufnahme der Sysex-
Übertragung von Ihrem MIDI-Gerät am 
Timeline-Einfügepunkt zu beginnen, 
aktivieren Sie „Wait For Note“.

Die Positionierung von Sysex-Event-
Blöcken kann auch mit dem Shift-Befehl 
(siehe „Shift-Befehl“ auf Seite 864) bzw. 
dem Nudge-Befehl (siehe „Verschieben 
von Clips mit der Nudge-Funktion“ auf 
Seite 607) erfolgen.

Einzelne Sysex-Event-Blöcke können 
auch durch Klicken mit dem Pencil-Tool 
bei gedrückter Alt-Taste (Windows) oder 
Wahltaste (Mac) gelöscht werden.
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Note- und Controller-Chasing

Note-Chasing
Das Note-Chasing ermöglicht es, lang anhaltende 
MIDI-Noten abzuhören, auch wenn die Wiedergabe 
erst nach ihrem eigentlichen Startpunkt einsetzt. 
Wenn also etwa der Anfangspunkt einer Note bei 
1|1|000 liegt und die Notenlänge 8 Takte umfasst 
(bis 9|1|000), können Sie dank Note-Chasing die 
Wiedergabe erst ab Takt 5 beginnen und die Note, 
obwohl ihr Anfangspunkt bei 1|1|000 liegt, 
trotzdem bis zu ihrem Endpunkt 9|1|000 abhören.

Die Note Chasing-Funktion kann für jede MIDI- 
oder Instrumentenspur einzeln aktiviert bzw. 
deaktiviert werden. Standardmäßig ist die Note 
Chasing-Funktion für neue MIDI- und 
Instrumentenspuren aktiviert.

So aktivieren Sie die Note Chasing-Funktion für 
eine MIDI-Spur:

 Klicken Sie auf den Playlist-Selektor der 
jeweiligen Spur und aktivieren Sie die Note 
Chasing-Option.

Deaktivieren Sie die Note Chasing-Option 
unbedingt, wenn Sie mit Samplern arbeiten, 
die auf die Wiedergabe von Loops eingestellt sind. 
Wenn auf einer MIDI-Spur etwa ein viertaktiger 

Schlagzeug-Loop getriggert wird, die Wiedergabe 
aber erst beim dritten Takt einsetzt, startet die 
Wiedergabe des Loops an der falschen Stelle und 
läuft nicht mit den anderen Spuren synchron. 

Controller- und Programm-
Chasing
Auch Controller-Events und Program Changes auf 
MIDI-Spuren werden von Pro Tools mithilfe der 
Chasing-Funktion aktualisiert. Dadurch wird 
sichergestellt, dass alle Controller-Werte und 
Patches für MIDI-Geräte immer richtig eingestellt 
sind.

Nehmen wir etwa an, eine MIDI-Spur mit 
32 Takten beginnt mit einer MIDI-Lautstärke 
von 127, die im letzten Takt auf den Wert 0 
gefadet wird. Wenn Sie nun, nachdem Sie die Spur 
vollständig wiedergegeben haben, diese ab Takt 8 
erneut abspielen, wird über die Chasing-Funktion 
der Lautstärkewert von 127 (vom Anfang der 
Spur) ermittelt und an das der Spur zugewiesene 
MIDI-Gerät gesendet. Andernfalls wäre die Spur 
nicht zu hören, da der letzte gesendete 
Lautstärkewert (vom Ende der Spur) 0 betrug.

Das Chasing findet ebenso für den Standard-
Program Change wie auch für alle weiteren für die 
Spur festgelegten Program Change-Events statt. 
Der Standard-Program Change für eine Spur wird 
daher auch dann an das der Spur zugewiesene 
Gerät übermittelt, wenn Sie die Wiedergabe der 
Spur erst nach dem Anfangspunkt des Program 
Change-Events beginnen.

Note-Chasing im Playlist-Selektor aktiviert
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Standard-Controller-Werte und 
Chasing
Obwohl bei neu erzeugten MIDI-Spuren in den 
Playlists für Continuous Controller Standardwerte 
erscheinen, sind diese nicht tatsächlich als MIDI-
Events vorhanden. So werden Sie etwa beim 
Betrachten der Mod Wheel-Playlist einer MIDI-
Spur feststellen, dass die Breakpoint-Linie auf den 
Standardwert 0 eingestellt ist. Da das 
Modulationsrad Ihres MIDI-Controllers jedoch 
absichtlich auf einen anderen Wert eingestellt sein 
kann, wird der Standardwert der Spur während der 
Wiedergabe nicht übermittelt.

Wenn Sie beispielsweise eine Mod Wheel-
Automation aufnehmen, die sich zum Ende der 
Spur von 0 auf 90 ändert, und Sie dann am Anfang 
der Spur oder an einer Stelle vor der Änderung mit 
der Wiedergabe beginnen, soll der Mod Wheel-
Wert vermutlich nicht bei 90 bleiben, bis der Wert 
0 erreicht wurde.

Um sicherzustellen, dass der Standardwert eines 
Controllers für eine Playlist übermittelt (und 
nachverfolgt) wird, klicken Sie auf den ersten 
Breakpoint am Anfang der Spur, verschieben Sie 
ihn leicht und setzen Sie ihn dann auf den 
Standardwert zurück.

Zeitlich versetzte 
Wiedergabe von MIDI-Spuren 
(Offset)
In Pro Tools können MIDI-Spuren entweder 
global oder einzeln zeitlich versetzt 
wiedergegeben werden.

Global MIDI Playback Offset
Pro Tools bietet eine MIDI-Offset-Voreinstellung, 
mit der festgelegt wird, dass MIDI- und 
Instrumentenspuren um eine bestimmte Anzahl 
von Samples früher oder später (als Audiospuren) 
wiedergegeben werden. Durch Festlegung eines 
Offsets wird ausschließlich der Zeitpunkt der 
Wiedergabe geändert. Die Darstellung der MIDI-
Daten im Edit-Fenster bleibt davon unberührt.

Diese Funktion wird hauptsächlich angeboten, 
um die Abhörlatenz von Audiosignalen bei 
hostbasierten Pro Tools-Systemen auszugleichen. 
Wenn Sie die Ausgangssignale Ihres externen 
MIDI-Instruments über ein externes Mischpult 
oder Soundsystem (oder auch über Kopfhörer) 
abhören, entstehen keine Latenzen. Wenn Sie 
jedoch die Ausgabe der MIDI-Geräte über ein 
Pro Tools-Interface (etwa Geräte der 003-
Produktfamilie) abhören, klingen die MIDI-
Spuren im Vergleich zu den Audiospuren leicht 
verzögert. Je höher die Einstellung für H/W Buffer 

Size (128, 256, 512 oder 1024 Samples), desto 
länger die Latenzzeit. 

Wenn in einem Pro Tools HD-System die 
Delay Compensation-Funktion aktiv ist, wird 
die Verzögerung von MIDI-Spuren 
automatisch ausgeglichen, um Niedriglatenz-
Monitoring zu ermöglichen. Weitere 
Informationen finden Sie unter 
„Verzögerungsausgleich für MIDI“ auf 
Seite 1029.
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Durch Konfigurieren der Einstellung Global MIDI 

Playback Offset können Sie erreichen, dass Ihre 
MIDI-Spuren etwas (also eine bestimmte Anzahl 
von Samples) früher abgespielt werden, und damit 
die Latenz beim Abhören von Audio in 
hostbasierten Pro Tools-Systemen kompensieren.

So konfigurieren Sie die Option „Global MIDI 
Playback Offset“:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die MIDI-Registerkarte.

2 Geben Sie die Anzahl von Samples (von 
–10.000 bis 10.000) für die Einstellung Global 

MIDI Playback Offset ein. Bei einem negativen 
Wert werden die MIDI-Spuren früher als die 
Audiospuren wiedergegeben, bei einem 
positiven Wert werden die MIDI-Spuren später 
wiedergegeben.

Um die Latenz in hostbasierten Pro Tools-Systemen 
zu kompensieren, sollten Sie für das Offset einen 
Wert eingeben, der ungefähr dem H/W Buffer Size-
Wert entspricht.

3 Klicken Sie auf OK.

Offsets für einzelne MIDI- und 
Instrumentenspuren

Mit Pro Tools können Sie Offsets auch auf 
einzelne MIDI- und Instrumentenspuren 
anwenden, um gerätebedingte Verzögerungen bei 
der Wiedergabe (also die Zeit, die benötigt wird, 
um Events auf einem Sampler oder Synthesizer 
auszulösen) auszugleichen.

Wenn beispielsweise die in Pro Tools von einer 
Audiospur wiedergegebenen Kick-Drums mit den 
von einem MIDI-Gerät gespielten Kick-Drums 
genau synchron laufen sollen, können Sie dies 
durch ein entsprechend eingestelltes MIDI-Offset 
erreichen. In diesem Beispiel würde es in der Regel 
mindestens fünf Millisekunden dauern, bis die 
entsprechenden MIDI-Noten ausgelöst würden, 
je nach MIDI-Gerät eventuell sogar noch länger.

Sie können die Latenz einer MIDI-Spur und des ihr 
zugewiesenen MIDI-Geräts messen, indem Sie 
dessen Audiosignale auf eine Audiospur in 
Pro Tools aufnehmen. Vergleichen Sie die 
Position der Samples der aufgenommenen 
Audiosignale mit denen der ursprünglichen MIDI-
Noten, um die Latenz zu berechnen.

Die Option „Global MIDI Playback Offset“ 
kann auch vom MIDI Track Offsets-Fenster 
aus eingestellt werden. Sie können auch eine 
Verzögerung bei den MIDI-Echtzeit-
Eigenschaften zum zeitlichen Versetzen von 
MIDI verwenden (siehe „MIDI-Echtzeit-
Eigenschaften“ auf Seite 726).

Messen der MIDI-Latenz

Ungefähres Offset in
Samples

Aus MIDI-Gerät aufgenommene 
Audiosignalspitze

MIDI Note On
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So konfigurieren Sie das Offset für eine MIDI- oder 
Instrumentenspur:

1 Wählen Sie Event > MIDI Track Offsets.

2 Klicken Sie auf die Sample Offset-Spalte für die 
gewünschte MIDI- oder Instrumentenspur und 
geben Sie die Anzahl von Samples für das 
Offset ein (von –10.000 bis 10.000). Bei einem 
negativen Wert werden die MIDI- oder 
Instrumentenspuren früher als die Audiospuren 
wiedergegeben, bei einem positiven Wert 
werden die MIDI- oder Instrumentenspuren 
später wiedergegeben.

Die dem eingegebenen Samplewert entsprechende 
zeitliche Verzögerung wird in der Msec Offset-
Spalte in Millisekunden angegeben. Dieser Wert 
kann nicht bearbeitet werden. Er wird automatisch 
aktualisiert, sobald ein neuer Wert in die Sample 
Offset-Spalte eingegeben wird.

3 Drücken Sie die Eingabetaste (Windows) bzw. 
die Return-Taste (Mac), um den eingegebenen 
Wert zu bestätigen.

Um die Offsets für sämtliche MIDI- und 
Instrumentenspuren zurückzusetzen, klicken Sie 
auf die Reset-Schaltfläche oben links im Fenster.

Notenhänger
Wenn es bei einem Ihrer MIDI-Geräte zu einem 
sogenannten Notenhänger kommt, können Sie 
diesen mit dem Befehl All MIDI Notes Off beheben.

So beseitigen Sie Notenhänger:

 Wählen Sie Event > All MIDI Notes Off. 

Remove Duplicate Notes
Mithilfe des Remove Duplicate Notes-Befehls 
können Sie doppelt vorhandene MIDI-Noten 
entfernen. Wenn eine Note innerhalb der ersten 
25 % der Dauer einer Note derselben Tonhöhe, 
die bereits erklingt, einsetzt (bzw. innerhalb einer 
Achtelnote, je nachdem, was kürzer ist), wird sie 
als Duplikat angesehen und mit der 
vorangehenden Note kombiniert. Setzt sie erst 
später ein, wird die erste Note verkürzt, sodass sie 
mit dem gleichen Tick endet, mit dem die neue 
einsetzt.

So entfernen Sie Noten-Duplikate:

1 Nehmen Sie eine Edit-Selektion vor, welche die 
Duplikate einschließt, die entfernt werden 
sollen.

2 Wählen Sie Event > Remove Duplicate Notes.

MIDI Track Offsets-Fenster

Drücken Sie Strg + Umschalt + „.“ 
(Windows) oder Bfhl + Umschalt + ] + „.“ 
(Mac), um den All MIDI Notes Off-Befehl 
aufzurufen.
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MIDI-Echtzeit-Eigenschaften
Über die MIDI-Echtzeit-Eigenschaften können Sie 
einige MIDI-Eigenschaften von MIDI- und 
Instrumentenspuren (oder MIDI-Clips) während 
der Wiedergabe ändern. Es gibt fünf verschiedene 
Arten von MIDI-Echtzeit-Eigenschaften: 
„Quantize“, „Duration“, „Delay“, „Velocity“ und 
„Transpose“. 

MIDI-Echtzeit-Eigenschaften können während 
der Wiedergabe angepasst werden. Sie können 
dabei das Ergebnis hören und entsprechende 
Korrekturen vornehmen. Sobald Sie die 
gewünschten Einstellungen gefunden haben, 
können Sie diese in die ausgewählten Spuren oder 
Clips schreiben. Dadurch werden die betreffenden 
MIDI-Eigenschaften der ausgewählten Spuren 
oder Clips überschrieben und die Anzeige der 
Echtzeit-Eigenschaften wird auf die 
Standardeinstellungen zurückgesetzt.

Echtzeit-Eigenschaften können im Real-Time 
Properties-Bedienfeld im Edit-Fenster oder im 
Real-Time Properties-Fenster angepasst werden.

Real-Time Properties-
Bedienfeld
Das Real-Time Properties-Bedienfeld im Edit-
Fenster steht nur für Spuren zur Verfügung. 
Für die Anwendung von Echtzeit-Eigenschaften 
auf Clips ist das Real-Time Properties-Fenster 
zu verwenden (siehe „Real-Time Properties-
Fenster“ auf Seite 727).

So aktivieren Sie das Real-Time Properties-
Bedienfeld im Edit-Fenster:

 Wählen Sie View > Edit Window > Real-Time 

Properties. 

Wenn die Spurhöhe auf „Micro“, „Mini“ oder 
„Small“ eingestellt ist, zeigt die Real-Time 
Properties-Spalte nur eine bzw. zwei 
Eigenschaften an. Dabei handelt es sich um die 
erste bzw. die ersten beiden Eigenschaften.

So wählen Sie bei der Spurhöhe „Mini“ oder 
„Small“ eine andere Echtzeit-Eigenschaft:

 Halten Sie die Strg-Taste (Windows) bzw. 
die Befehlstaste (Mac) gedrückt, klicken Sie 
auf eine Echtzeit-Eigenschaft und wählen Sie 
im Popup-Menü die gewünschte andere 
Eigenschaft aus.

Damit MIDI-Echtzeit-Eigenschaften auf 
eingehende MIDI-Daten mit aktivierter 
MIDI Thru-Option angewendet werden, 
müssen die entsprechenden MIDI- und 
Instrumentenspuren scharfgeschaltet sein.

Real-Time Properties-Spalte im Edit-Fenster

Popup-Menü der Echtzeit-Eigenschaften mit der 
Spurhöhe „Mini“
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Real-Time Properties-Fenster
Im Real-Time Properties-Fenster können Sie 
Echtzeit-Eigenschaften auf ausgewählte Spuren 
oder Clips anwenden.

So öffnen Sie das Real Time Properties-Fenster:

 Wählen Sie Event > MIDI Real-Time Properties. 

Im Real-Time Properties-Fenster können Sie 
entweder spur- oder clipbasierte Echtzeit-
Eigenschaften anwenden. Dazu nehmen Sie eine 
Edit-Selektion vor und wählen im Apply To-Popup-
Menü die gewünschten Spuren bzw. Clips aus.

Erweitertes Real-Time Properties-Fenster

Im Real-Time Properties-Fenster gibt es für jede 
der Optionen „Quantize“, „Duration“ und 
„Velocity“ zusätzliche Einstellungen, die über das 
dazugehörige Expand/Collapse-Dreieck ein- und 
ausgeblendet werden können. 

Real-Time Properties-Fenster mit aktivierten 
Eigenschaften

Real-Time Properties-Fenster, erweiterte Darstellung

Expand/
Collapse-
Schaltflächen
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Aktivieren von Echtzeit-
Eigenschaften

So aktivieren Sie Echtzeit-Eigenschaften:

1 Selektieren Sie eine Spur oder nehmen Sie eine 
Edit-Selektion vor.

2 Im Real-Time Properties-Bedienfeld des Edit-
Fensters oder im Real-Time Properties-Fenster 
wählen Sie die Echtzeit-Eigenschaften aus, 
indem Sie auf den entsprechenden Namen 
klicken („Quantize“, „Duration“, „Delay“, 
„Velocity“ oder „Transpose“). Aktivierte 
Echtzeit-Eigenschaften sind markiert und 
zeigen ihre Einstellungen an.

3 Wenn Sie das Real-Time Properties-Fenster 
benutzen und „Link Track and Edit Selection“ 
aktiviert ist, wählen Sie die Spur bzw. den Clip 
aus dem Apply To-Popup-Menü.

4 Konfigurieren Sie die Echtzeit-Eigenschaften 
(siehe „Real-Time Properties-Einstellungen“ 
auf Seite 728).

Aktivierte Echtzeit-Eigenschaften sind bei der 
Wiedergabe und beim Durchspielen für die 
ausgewählten Spuren und Clips hörbar.

Real-Time Properties-
Einstellungen

Quantisieren
„Quantize“ kann auf einem Raster oder einer 
Groove-Vorlage basieren. Für Raster-Quantize sind 
außer den üblichen MIDI-Quantize-Eigenschaften 
zusätzliche N-tolen- und Raster-Offset-Einstellungen 
verfügbar. Für Groove-Quantize werden zusätzliche 
Steuerelemente angeboten, mit denen Groove-Dauer 
und -Velocitys bestimmt werden. Sowohl für Raster- 
als auch für Groove-Quantize können Werte für 
„Strength“, „Include“ und „Random“ eingestellt 
werden.

Quantize-Popup-Menü. – wählen Sie den 
Quantisierungswert aus. Dazu gehören alle 
Standardnotenwerte zwischen ganzen und 
Vierundsechzigstel-Noten (einschließlich 
punktierter Noten und Triolenoptionen). Dieses 
Popup-Menü bietet auch Zugang zu allen 
standardmäßigen und anwenderdefinierten 
Groove-Vorlagen.

Bei Verwendung der Real-Time Properties 
aktivieren Sie „Link Track and Edit 
Selection“, um von der Edit-Selektion aus 
eine Spur-Selektion vornehmen zu können 
(siehe „Koppeln und Entkoppeln von Spur- 
und Edit-Selektion“ auf Seite 577).

„Quantize“ lässt sich nicht als Echtzeit-
Eigenschaft auf „MIDI Input“ und „MIDI 
Thru“ anwenden.

Auswählen eines Raster-Quantize-Werts oder einer 
Groove-Vorlage
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Swing. – geben Sie den Swing-Wert als 
Prozentsatz zwischen 0 und 300 % ein. 

Tuplet. – aktivieren Sie Tuplet und geben Sie das 
Verhältnis für die N-tole (1–99) ein, etwa 3 zu 2 
oder 5 zu 4. Tuplet ist nur im erweiterten Real-
Time Properties-Fenster verfügbar.

Offset. – aktivieren Sie Offset und geben Sie den 
Offset-Wert in Ticks zwischen –2 000 und 2 000 
ein. Offset ist nur im erweiterten Real-Time 
Properties-Fenster verfügbar.

Strength. – aktivieren Sie Strength und geben Sie 
den Wert als Prozentsatz zwischen 0 und 100 % 
ein. Strength ist nur im erweiterten Real-Time 
Properties-Fenster verfügbar.

Include. – aktivieren Sie Include und geben Sie 
den Bereich zwischen 0 und 100 % ein. Include ist 
nur im erweiterten Real-Time Properties-Fenster 
verfügbar.

Random. – aktivieren Sie Random und geben Sie 
einen Prozentwert zwischen 0 und 100 % ein. 
Random ist nur im erweiterten Real-Time 
Properties-Fenster verfügbar.

Duration
„Duration“ kann dazu verwendet werden, MIDI-
Noten um einen festen Wert oder einen 
Prozentwert zu verlängern oder zu verkürzen. Dies 
ist nützlich, um Legato- oder Staccato-Passagen zu 
erstellen.

Duration Mode-Popup-Menü

Wählen Sie im Duration Mode-Popup-Menü eine 
der folgenden Optionen: Set, Add, Subtract, Scale, 
Legato/Gap oder Legato/Overlap.

Stellen Sie. – setzt die Noten auf die angegebene 
Dauer.

Add. – addiert die angegebene Dauer zur aktuellen 
Länge jeder Note.

Subtract. – subtrahiert die angegebene Dauer von 
der aktuellen Länge jeder Note.

Scale. – skaliert die aktuelle Dauer jeder Note um 
einen Wert zwischen 1 und 400 %.

Legato/Gap. – verlängert jede Note bis zur 
folgenden. Die angegebene Dauer wird 
subtrahiert, um zwischen den Noten einheitliche 
Abstände zu schaffen.

Legato/Overlap. – verlängert jede Note bis zur 
folgenden. Die angegebene Dauer wird dann 
addiert, um eine gleichmäßige Überlappung zu 
erzeugen.

Dauergröße

Wenn das Ticks/Notes-Popup-Menü auf „Ticks“ 
eingestellt ist, geben Sie eine Dauer als Anzahl von 
Viertelnoten plus eine Anzahl von Ticks ein, 
etwa 4|000. Wenn das Ticks/Notes-Popup-Menü 
auf einen Notenwert eingestellt ist, geben Sie 
einen Multiplikationsfaktor für diesen Notenwert 
ein, etwa sieben 16tel-Noten.

„Duration“ lässt sich nicht als Echtzeit-
Eigenschaft auf „MIDI Input“ und „MIDI 
Thru“ anwenden.

Auswählen eines Duration-Modus
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Ticks/Notes-Popup-Menü

Im Ticks/Notes-Popup-Menü können Sie „Ticks“ 
oder einen Notenwert für die Notendauer 
auswählen. Außerdem gibt es ein Ticks/Notes-
Popup-Menü zum Festlegen der Mindest- und 
Höchstdauer („Min“, „Max“).

Mindest- und Höchstdauer („Min“ und „Max“)

Aktivieren Sie „Min“ und/oder „Max“ und geben 
Sie einen Wert in Viertelnoten plus Ticks oder als 
Vielfaches eines Notenwerts ein. Die Optionen für 
Mindest- und Höchstdauer (Min und Max) sind nur 
im erweiterten Real-Time Properties-Fenster 
verfügbar.

Delay
Mit „Delay“ können Sie alle MIDI-Daten in 
ausgewählten Clips bzw. Spuren verzögern oder 
vorziehen. Wählen Sie „+“ im Delay-Popup-
Menü, um MIDI-Daten zu verzögern, oder „–“, 
um sie vorzuziehen. Wählen Sie im Ticks/
Milliseconds-Popup-Menü die gewünschte 
Einheit, Ticks oder MS (Millisekunden). Geben Sie 
das Ausmaß der Verzögerung in Ticks oder 
Millisekunden ein. Die Verzögerung kann 
maximal 2 000 ms oder 999 Ticks betragen.

Velocity
Unter „Velocity“ können Sie die MIDI-Velocity 
um einen Prozentsatz oder einen konstanten Wert 
ändern. Geben Sie im Dynamics-Feld einen 
Prozentsatz ein, um die Velocity um den 
Mittelwert von 64 zu skalieren. Auf Wunsch 
können Sie auch einen Offset eingeben: durch 
Addieren (+) oder Subtrahieren (–) von Werten 
zwischen 1 und 127. Sie können auch Grenzwerte 
für minimale und maximale Velocity eingeben. 
Die Optionen für den minimalen und maximalen 
Velocity-Wert (Min und Max) sind nur im 
erweiterten Real-Time Properties-Fenster 
verfügbar.

Ticks/Notes-Popup-Menüs für Echtzeit-Eigenschaften

Ticks/Milliseconds-Popup-Menüs für Echtzeit-
Eigenschaften

„Duration“ lässt sich nicht als Echtzeit-
Eigenschaft auf „MIDI Input“ und „MIDI 
Thru“ anwenden.

„Velocity“ kann als Echtzeit-Eigenschaft auf 
„MIDI Input“ und „MIDI Thru“ für 
scharfgeschaltete MIDI- und 
Instrumentenspuren angewendet werden.
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Transpose
Mit „Transpose“ können Sie MIDI-Noten um eine 
bestimmte Anzahl von Oktaven und 
Halbtonschritten oder in Tonleiterschritten 
(basierend auf dem Generalvorzeichen) 
transponieren. Oder Sie transponieren auf eine 
bestimmte Tonhöhe. Wählen Sie By To oder In aus 
dem Transpose-Popup-Menü, je nachdem, ob Sie 
um ein bestimmtes Intervall, auf eine bestimmte 
Tonhöhe oder in Tonleiterschritten transponieren 
möchten. 

Für die Transposition um ein Intervall geben Sie 
die Anzahl von Oktaven und Halbtönen als 
positive oder negative Zahl ein. 

Für die Transposition auf eine Tonhöhe geben Sie 
den MIDI-Notennamen ein.

Für eine Transposition in Tonleiterschritten geben 
Sie die Anzahl der Schritte als positive oder 
negative Zahl ein. Geben Sie beispielsweise +2 für 
eine Transposition um Terzen in einer Tonart ein 
(eine Prim plus einer Sekund entspricht einer 
Terz).

Echtzeit-Eigenschaften für 
Spuren und Clips
Echtzeit-Eigenschaften können auf eine ganze 
Spur (alle Clips auf der Spur) oder auf einzelne 
Clips angewendet werden. Eigenschaften auf 
Spurebene bieten Echtzeit-MIDI-Input-
Verarbeitung von Velocity und Transposition.

Das Vorhandensein von spurbasierten Echtzeit-
Eigenschaften wird durch ein „T“ (wie in „track“) 
in der rechten oberen Ecke der MIDI-Clips 
angezeigt. Das Vorhandensein von Clip-basierten 
Echtzeit-Eigenschaften wird durch ein „R“ in der 
rechten oberen Ecke des Clips angezeigt. 
Clipgrenzen, einschließlich der Anzeige von „T“ 
und „R“, werden in der Notendarstellung und in 
den MIDI Editor-Fenstern angezeigt, nicht aber im 
Score Editor-Fenster.

Clipbasierte Echtzeit-Eigenschaften

Clipbasierte Echtzeit-Eigenschaften können nur 
über das Real-Time Properties-Fenster 
angewendet werden (Event > MIDI Real-Time 

Properties). Echtzeit-Eigenschaften lassen sich auf 
mehrere Clips anwenden. Wenn Echtzeit-
Eigenschaften auf einen Clip angewendet wurden, 
kann der Clip verschoben oder kopiert und an 
anderer Stelle eingefügt werden und dabei seine 
Echtzeit-Eigenschaften beibehalten.

„Transpose“ kann als Echtzeit-Eigenschaft 
auf „MIDI Input“ und „MIDI Thru“ für 
scharfgeschaltete MIDI- und 
Instrumentenspuren angewendet werden.

Anzeigen für spur- und clipbasierte Echtzeit-
Eigenschaften

Anzeige für spurbasierte 
Echtzeit-Eigenschaften

Anzeige für clipbasierte 
Echtzeit-Eigenschaften
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Spurbasierte Echtzeit-Eigenschaften

Alle spurbasierten Echtzeit-Eigenschaften werden 
einheitlich über die ganze Spur hinweg auf die 
MIDI-Daten angewandt. Jedoch haben Clips mit 
clipbasierten Echtzeit-Eigenschaften Vorrang vor 
spurbasierten Echtzeit-Eigenschaften. Sie können 
clipbasierte Echtzeit-Eigenschaften löschen, 
indem Sie den Clip auswählen und im Real-Time 
Properties-Fenster auf Clear Clip Properties 
klicken (siehe „Schreiben von Echtzeit-
Eigenschaften in Spuren und Clips“ auf Seite 732).

Zur Verbesserung der Flexibilität sind Echtzeit-
Eigenschaften, wenn sie auf Spurbasis zugewiesen 
werden, tatsächlich in einer Spur-Playlist 
enthalten. Dies erlaubt Ihnen, mehrere Playlists 
mit verschiedenen Einstellungen für Echtzeit-
Eigenschaften zu erstellen.

Schreiben von Echtzeit-
Eigenschaften in Spuren und 
Clips
Wenn Sie die gewünschten Einstellungen 
gefunden haben, können Sie die entsprechenden 
Echtzeit-Eigenschaften im Real-Time Properties-
Fenster in die ausgewählten Spuren oder Clips 
schreiben. Echtzeit-Eigenschaften werden auf die 
aktuellen MIDI-Daten auf der Spur oder in einem 
Clip angewendet.

So schreiben Sie Echtzeit-Eigenschaften auf 
Spuren:

1 Aktivieren Sie „Link Track and Edit Selection“.

2 Wählen Sie eine oder mehrere Spuren, auf die 
Sie Echtzeit-Eigenschaften anwenden wollen.

3 Öffnen Sie das Real-Time Properties-Fenster 
(Event > MIDI Real-Time Properties).

4 Wählen Sie im Popup-Menü Real-Time 

Properties Apply To die Option Tracks.

5 Konfigurieren Sie die Echtzeit-Eigenschaften.

6 Sie haben folgende Möglichkeiten:

• Klicken Sie im Real-Time Properties-Fenster 
auf Write to Track.

• Wählen Sie Track > Write MIDI Real-Time 

Properties.

So schreiben Sie Echtzeit-Eigenschaften in Clips:

1 Wählen Sie einen oder mehrere Clips, auf die 
Sie Echtzeit-Eigenschaften anwenden wollen.

2 Öffnen Sie das Real-Time Properties-Fenster 
(Event > MIDI Real-Time Properties).

3 Wenn „Link Track and Edit Selection“ aktiviert 
ist, wählen Sie im Real-Time Properties Apply 

To-Popup-Menü die Option Clips.

4 Konfigurieren Sie die Echtzeit-Eigenschaften.

5 Klicken Sie im Real-Time Properties-Fenster 
auf die Write to Clip-Schaltfläche.

So löschen Sie Echtzeit-Eigenschaften aus einem 
Clip:

1 Wählen Sie den Clip, aus dem Sie Echtzeit-
Eigenschaften entfernen wollen.

2 Öffnen Sie das Real-Time Properties-Fenster 
(Event > MIDI Real-Time Properties).

3 Wählen Sie im Real-Time Properties Apply To-
Popup-Menü die Option Clips.

4 Klicken Sie auf die Clear Clip Properties-
Schaltfläche.
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Echtzeit-Eigenschaften in 
der MIDI Event-Liste
In der MIDI Event-Liste wird das Vorhandensein 
von spurbasierten Echtzeit-Eigenschaften durch 
ein „T“ rechts neben jedem Event angezeigt. 
Clipbasierte Echtzeit-Eigenschaften werden durch 
ein „R“ gekennzeichnet.

Anzeigen der Auswirkungen 
von Echtzeit-Eigenschaften
Die Option Display Events as Modified by the 

Real-Time Properties bestimmt, ob Pro Tools die 
Effekte von Echtzeit-Eigenschaften im Edit-
Fenster, in den MIDI Editor-Fenstern, im Score 
Editor-Fenster und in der MIDI Event-Liste 
anzeigt. Das Edit-Fenster, die MIDI Editor-
Fenster, das Score Editor-Fenster und die MIDI 
Event-Liste zeigen die Effekte von Echtzeit-
Eigenschaften an, wenn die Option Display Events 

as Modified by Real-Time Properties aktiviert ist. 
Ist diese Option deaktiviert, so sind die Effekte der 
Real-Time Properties zwar hörbar, aber nicht 
sichtbar. Das heißt, Sie sehen die Noten und andere 
MIDI-Events in ihrer ursprünglichen Position, 
Tonhöhe, Dauer und Velocity, aber Sie hören sie 
so, wie sie durch die Real-Time Properties-
Einstellungen geändert werden. 

So aktivieren bzw. deaktivieren Sie „Display 
Events as Modified by Real-Time Properties“:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die MIDI-Registerkarte.

2 Aktivieren bzw. deaktivieren Sie die Option 
Display Events as Modified by Real-Time 

Properties.

3 Klicken Sie auf OK.

Anzeige der Auswirkungen von Echtzeit-
Eigenschaften in der MIDI Event-Liste

Die MIDI Event-Liste berücksichtigt die 
Auswirkungen von Echtzeit-Eigenschaften, wenn 
die Option Display Events as Modified by Real-

Time Properties aktiviert ist. Beim Bearbeiten oder 
Einfügen eines Events in Spuren oder Clips mit 
aktiven Echtzeit-Eigenschaften berücksichtigt 
Pro Tools die Eigenschaften und bearbeitet ggf. 
das Event entsprechend den Echtzeit-
Eigenschaften oder fügt es dementsprechend an 
einer anderen Stelle ein.

Anzeige der Auswirkungen von Echtzeit-
Eigenschaften im Edit-Fenster

MIDI-Events erscheinen im Edit-Fenster, in den 
MIDI Editor-Fenstern und im Score Editor-Fenster 
an der Stelle, an der sie hörbar sind, wenn in den 
MIDI-Voreinstellungen die Option Display Events 

as Modified by Real-Time Properties aktiviert ist. 
MIDI-Events werden jedoch erst an ihre geänderte 
Position geschrieben, wenn die Echtzeit-
Eigenschaften in die Spur bzw. den Clip 
geschrieben werden.

Beim Verschieben von MIDI-Events verschieben 
sich die effektiven Positionen (Tonhöhe oder Zeit) 
in dem Maße, wie die Events gezogen werden, 
aber die Auswirkungen der Echtzeit-
Eigenschaften werden angezeigt.

Beim Bearbeiten oder Einfügen eines Events in 
eine Spur oder einen Clip mit aktiven Echtzeit-
Eigenschaften berücksichtigt Pro Tools die 
Eigenschaften und bearbeitet ggf. das Event 
entsprechend den Auswirkungen der Echtzeit-
Eigenschaften oder fügt es dementsprechend an 
einer anderen Stelle ein.

Weitere Informationen zur MIDI Event-Liste 
finden Sie unter Kapitel 34: „MIDI Event-
Liste“..
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Kapitel 32: MIDI-Editoren

Pro Tools enthält MIDI Editor-Fenster für detailliertes MIDI-Editing.

MIDI Editor-Fenster

Solo

Stummschaltung
Notations-
darstellung

Edit-Tools

Track Edit-Selektor

Default Note Duration
Default Note Velocity

Play MIDI Notes While Editing

Mirrored MIDI Editing

Link Timeline and Edit Selection

Edit-Modi Cursor-Position Grid-Selektor

Tastaturfokus

MIDI Editor-Menü

Target
(Ziel)

Nudge-
Selektor

Groups-Liste

Spurenliste
Velocity-, Controller- und 

Automation-Lanes
Überkopierte MIDI- und 

Instrumentenspuren

Zoom-Steuerelemente
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Überkopierte MIDI- und Instrumentenspuren

In MIDI Editor-Fenstern können MIDI-Daten 
(Noten, Velocity-Werte und Continuous 
Controller-Daten) für eine oder mehrere 
MIDI- oder Instrumentenspuren angezeigt und 
bearbeitet werden. Beim Anzeigen mehrerer 
Spuren in einem MIDI Editor-Fenster werden 
MIDI-Noten aus anderen Spuren überkopiert. 
In MIDI Editor-Fenstern können auch 
Auxiliary-Eingangs-Spuren angezeigt werden.

Automation- und Controller-Lanes

Velocity-Werte, andere Continuous Controller-
Daten (MIDI- und Instrumentenspuren) sowie 
Automation-Daten (nur Instrumenten- und 
Auxiliary-Eingangs-Spuren) können zusammen 
mit MIDI-Noten bearbeitet werden und werden 
in Controller-Lanes unterhalb des Notes-
Fensterbereichs angezeigt. Velocity-Werte 
für MIDI-Noten auf mehreren Spuren werden 
ebenfalls in der Velocity-Lane festgelegt. Für alle 
anderen Automation- und Controller-Daten 
hingegen werden je Spur und je Automation- oder 
Controller-Typ zusätzliche Lanes angezeigt. 

Wenn beispielsweise zwei Instrumentenspuren 
im MIDI Editor-Fenster angezeigt werden, werden 
die MIDI-Noten für jede Spur im Notes-
Fensterbereich festgelegt, die Velocity-Werte 
für jede Spur in der Velocity-Lane. Sie würden 
jedoch zwei Mod Wheel Controller-Lanes und zwei 
Lautstärke-Lanes (jeweils eine pro Spur) sehen.

Öffnen eines MIDI 
Editor-Fensters
Führen Sie einen der folgenden Schritte aus, 
um ein MIDI Editor-Fenster zu öffnen:

 Wählen Sie Window > MIDI Editor.

 Rechtsklicken Sie im Edit-Fenster auf einen 
MIDI-Clip auf der Spur oder in den Spur-
Steuerelementen oder der Tracks-Liste auf den 
Spurnamen und wählen Sie Open In MIDI Editor.

 Klicken Sie im Score Editor-Fenster mit der 
rechten Maustaste auf die Partitur oder in der 
Tracks-Liste auf einen Spurnamen und wählen 
Sie Open In MIDI Editor.

Führen Sie einen der folgenden Schritte aus, 
um zusätzliche MIDI Editor-Fenster zu öffnen:

 Deaktivieren Sie die Target-Schaltfläche 
im geöffneten MIDI Editor-Fenster und öffnen 
Sie ein weiteres MIDI Editor-Fenster.

 Klicken Sie mit der rechten Maustaste 
im geöffneten MIDI Editor-Fenster und wählen 
Sie Open in New MIDI Editor.

So holen Sie ein geöffnetes MIDI Editor-Fenster 
in den Vordergrund:

 Wählen Sie Window > MIDI Editor und wählen Sie 
anschließend das gewünschte MIDI Editor-Fenster.

Mit den Tastenkombinationen Windows +„=“ 
oder Ctrl +„=“können Sie ebenfalls ein MIDI 
Editor-Fenster öffnen.

Wenn in den MIDI-Voreinstellungen von 
Pro Tools als MIDI Editor-Option die 
Einstellung „Double Clicking a MIDI Clip 
Opens“ ausgewählt wurde, können Sie auf 
einen MIDI-Clip doppelklicken, um ihn 
in einem MIDI Editor-Fenster zu öffnen.

Um durch alle geöffneten MIDI Editor-
Fenster zu blättern, drücken Sie 
Windows + „=“ (Windows) bzw. Ctrl + 
„=“ (Mac) so lange, bis das gewünschte 
Fenster im Vordergrund angezeigt wird.
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Symbolleiste im MIDI 
Editor-Fenster
Bis auf wenige Ausnahmen gleicht die Symbolleiste 
im MIDI Editor-Fenster der Symbolleiste im Edit-
Fenster. Jedes MIDI Editor-Fenster und das Edit-
Fenster können unabhängig voneinander konfiguriert 
werden. So können Sie beispielsweise die 
Notationsdarstellung in einem MIDI Editor-Fenster 
aktiviert und in einem anderen deaktiviert haben, 
oder auch ein MIDI Editor-Fenster in den Grid-
Modus schalten, während für das Edit-Fenster der 
Slip-Modus aktiviert ist. Sie können darüber hinaus 
auch die Symbolleiste in MIDI Editor-Fenstern 
individuell anpassen.

Schaltflächen „Solo“ und „Mute“
In einem MIDI Editor-Fenster wirken sich die 
Schaltflächen „Solo“ und „Mute“ auf Spuren in allen 
Fenstern aus. Sie können hiermit entweder die 
Spuren im aktuellen MIDI Editor-Fenster ohne den 
Rest des Mixes, oder aber den Mix ohne die im MIDI 
Editor-Fenster angezeigten Spuren abhören.

Solo

Mit der Schaltfläche „Solo“ können Sie alle aktuell 
im MIDI Editor-Fenster angezeigten Spuren 
soloschalten.

Stummschaltung

Mit der Schaltfläche „Mute“ können Sie alle 
aktuell im MIDI Editor-Fenster angezeigten 
Spuren stummschalten.

Gemischte Mute- und Solo-Status

Die Schaltflächen „Solo“ und „Mute“ sind globale 
Steuerelemente, da sie alle in einem MIDI Editor-
Fenster aufgeführten Spuren betreffen. Wenn Sie 
Spuren, die auch im MIDI Editor-Fenster angezeigt 
werden, unabhängig voneinander im Edit-Fenster 
solo- oder stummschalten, wird das Erscheinungsbild 
der Schaltflächen „Solo“ und „Mute“ aktualisiert, 
sodass hier auf gemischte Status hingewiesen wird. 
Gemischte Solo- und Mute-Status treten auf, wenn 
eine oder mehrere Spuren, aber nicht alle, im MIDI 
Editor-Fenster solo- oder stummgeschaltet sind.

Notationsdarstellung
Mit der Schaltfläche „Notation View“ können Sie 
MIDI-Noten als Notensatz im MIDI Editor-
Fenster anzeigen. In der Notationsdarstellung 
werden MIDI- und Instrumentenspuren nicht 
überkopiert, sondern wie im Score Editor-Fenster 
in Form von Notenzeilen angezeigt.

Notationsdarstellung in einem MIDI Editor-Fenster 
aktiviert

Sie können in einem MIDI Editor-Fenster auf 
das Dialogfeld „Notation Display Track 
Settings“ zugreifen, wenn Sie sich in der 
Notationsdarstellung befinden. Wählen Sie 
die Option „Notation Display Track 
Settings“ aus dem Menü der Tracks-Liste 
oder klicken Sie mit der rechten Maustaste im 
Notes-Fensterbereich und wählen Sie die 
Option „Notation Display Track Settings“ 
aus dem Kontextmenü. Weitere 
Informationen finden Sie unter „Notation 
Display Track Settings“ auf Seite 766.
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Edit-Tools
Die Edit-Tools in MIDI Editor-Fenstern können 
als einzelnes Tool mit einem Popup-Menü zur 
Auswahl weiterer Tools oder als erweiterte, 
vollständige Reihe mit Edit-Tool-Symbolen ebenso 
wie im Edit-Fenster dargestellt werden. Die Edit-
Tools in MIDI Editor-Fenstern funktionieren 
für MIDI-Daten genauso wie im Edit-Fenster. 
Einstellungen für Edit-Tools können unabhängig in 
jedem MIDI Editor-Fenster vorgenommen werden 
und sind nicht an die Tool-Auswahl im Edit-Fenster 
und im Score-Editor gebunden.

Führen Sie einen der folgenden Schritte aus, 
um die erweiterten Edit-Tools in einem MIDI 
Editor-Fenster anzuzeigen:

 Klicken Sie auf das MIDI Editor Window 
Toolbar-Menü (Symbolleiste für das MIDI Editor-
Fenster) und wählen sie Expanded Edit Tools.

 Klicken Sie mit der rechten Maustaste auf 
die Symbolleiste und aktivieren Sie Expanded 
Edit Tools.

So zeigen Sie wieder ein einziges Edit-Tool-
Symbol mit dazugehörigem Popup-Menü an:

 Deaktivieren Sie Expanded Edit Tools.

Steuerelemente für das 
MIDI-Editing
Die Steuerelemente für das MIDI-Editing 
funktionieren in MIDI Editor-Fenstern und 
im Edit-Fenster gleich.

Track Edit-Selektor

Wenn im MIDI Editor-Fenster mehr als eine MIDI- 
oder Instrumentenspur angezeigt wird, können Sie 
mithilfe des Track Edit-Selektors einzelne Spuren für 
das Pencil-Tool freischalten. Nur auf diesen Spuren 
können Sie anschließend manuell MIDI-Noten 
einfügen. Außerdem können Sie die Tracks-Liste 
verwenden, um Spuren für das Pencil-Tool 
freizuschalten (siehe „Manuelles Einfügen von 
MIDI-Noten“ auf Seite 748).

Default Note Duration

Mit dem Selektor „Default Note Duration“ können 
Sie die Standardnotendauer für manuell eingefügte 
Noten festlegen.

Default Note On Velocity

Mit der Einstellung „Default Note On Velocity“ 
können Sie den Velocity-Standardwert für 
Notenanfänge manuell eingefügter Noten festlegen.

Play MIDI Notes When Editing
Wenn diese Option aktiviert ist, werden die 
entsprechenden MIDI-Noten beim Einfügen mit dem 
Pencil-Tool, beim Klicken mit dem Grabber-Tool, 
bei der Tab-Selektion oder beim Selektieren mit dem 
Note Selector-Tool abgespielt. 

Link Timeline and Edit Selection

Wenn diese Schaltfläche aktiviert ist, sind Timeline- 
und Edit-Selektion gekoppelt. Ist die Schaltfläche 
deaktiviert, können Sie die Timeline- und Edit-
Selektion unabhängig voneinander vornehmen.

Steuerelemente für das MIDI-Editing

Track Edit-Selektor

Default Note Duration

Default Note Velocity

Play MIDI Notes While Editing

Mirrored MIDI Editing
Link Timeline and Edit 
Selection

Die Einstellungen „Play MIDI Notes When 
Editing“, „Link Timeline and Edit Selection“ 
und „Mirrored MIDI Editing“ sind globale 
Einstellungen und stehen im Edit-Fenster, in 
MIDI Editor-Fenstern und im Score Editor-
Fenster zur Verfügung.
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Mirrored MIDI Editing

Mit dem sogenannten Mirrored MIDI Editing 
können Sie MIDI-Clips editieren und die 
Änderungen auf alle Kopien eines MIDI-Clips 
anwenden. Dies kann besonders beim Editieren 
von geloopten MIDI-Clips zweckdienlich sein.

Edit-Modi
Die Edit-Modi in MIDI Editor-Fenstern 
funktionieren für MIDI-Daten genauso wie im Edit-
Fenster. Edit-Modus-Einstellungen sind für jedes 
MIDI Editor-Fenster einzigartig und werden auch 
unabhängig vom Edit-Fenster festgelegt.

Anzeige der Cursor-Position
Die Anzeige der Cursor-Position in MIDI Editor-
Fenstern funktioniert in MIDI Editor-Fenstern und 
im Edit-Fenster gleich. 

Anzeige der Edit-Selektion
Die Anzeige der Edit-Selektion in MIDI Editor-
Fenstern funktioniert für MIDI-Daten in MIDI 
Editor-Fenstern genauso wie im Edit-Fenster. Die 
Anzeige der Selektion kann über die Symbolleiste 
ein- oder ausgeblendet werden.

Führen Sie einen der folgenden Schritte aus, 
um die Anzeige der Edit-Selektion in einem MIDI 
Editor-Fenster einzublenden (bzw. auszublenden):

 Klicken Sie auf das Menü der Symbolleiste 
für das MIDI Editor-Fenster und aktivieren 
(bzw. deaktivieren) Sie Selection Display.

 Klicken Sie mit der rechten Maustaste auf die 
Symbolleiste und aktivieren (bzw. deaktivieren) 
Sie Selection Display.

Grid- und Nudge-Selektor
Wenn im MIDI Editor-Fenstermenü die Option 
Expanded Grid/Nudge Display aktiviert ist, 
funktionieren Grid- und Nudge-Selektor für MIDI-
Daten in MIDI Editor-Fenstern genauso wie im 
Edit-Fenster. 

Ist die Option Expanded Grid/Nudge Display im 
MIDI Editor-Fenstermenü deaktiviert, können Sie 
mithilfe des Grid/Nudge Display-Selektor 
zwischen Grid- und Nudge-Anzeige wechseln.

Target (Ziel)
Grundsätzlich funktioniert die Target-Schaltfläche 
für MIDI Editor-Fenster genauso wie für Plug-In-, 
Output- und Send-Fenster. Darüber hinaus 
synchronisiert die Schaltfläche in einem MIDI 
Editor-Fenster die Timeline-Positionsdarstellung mit 
der Timeline-Positionsdarstellung im Edit-Fenster. 
Jegliche Änderungen an der Edit-Selektion im Edit-
Fenster werden im als Ziel ausgewählten MIDI 
Editor-Fenster widergespiegelt. Es kann immer nur 
ein MIDI Editor-Fenster als Ziel ausgewählt sein. 
Das als Ziel vorgesehene MIDI Editor-Fenster kann 
auch in einer Windows-Konfiguration gespeichert 
werden. 

Wenn der Mirrored MIDI Editing-Modus 
deaktiviert ist und Sie Noten geloopter Clips 
in der Notendarstellung editieren, wird beim 
Edit-Vorgang der Loop in Clips 
umgewandelt. In ähnlicher Weise führt das 
Editieren von Clip-Gruppen dazu, dass die 
Gruppen separiert werden.

Grid/Nudge-Selektor, Auswählen der Nudge-Anzeige
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Ein oder mehrere nicht als Ziel ausgewählte MIDI 
Editor-Fenster können gleichzeitig geöffnet und 
verfügbar sein, ebenso wie nicht als Ziel 
ausgewählte Plug-In-Fenster. Wenn Sie ein 
anderes MIDI Editor-Fenster als Ziel auswählen, 
wird das zuvor als Ziel ausgewählte Fenster nun 
nicht mehr als Ziel angesehen.

Das Fenster im Vordergrund empfängt unabhängig 
davon, ob es als Ziel ausgewählt wurde, 
Tastaturbefehle und Befehle über 
die Bedienoberfläche.

So aktivieren oder deaktivieren Sie die 
Target-Option für ein MIDI Editor-Fenster:

 Klicken Sie auf die Target-Schaltfläche für das 
MIDI Editor-Fenster, sodass es hervorgehoben 
(als Ziel ausgewählt) bzw. nicht hervorgehoben 
(die Auswahl als Ziel aufgehoben) wird.

MIDI Editor-Fenstermenü
Im MIDI Editor-Fenstermenü finden sich Anzeige- 
und Scrolling-Optionen für MIDI Editor-Fenster.

Optionen im MIDI 
Editor-Fenstermenü

Expanded Edit Tools

Bei aktivierter Option Expanded Edit Tools 
werden alle Edit-Tools in der Symbolleiste des 
MIDI Editor-Fensters angezeigt. 

Wenn diese Option nicht aktiviert ist, wird nur das 
Symbol für das ausgewählte Edit-Tool angezeigt. 
Die anderen Edit-Tools können aus dem Edit-
Tool-Popup-Menü ausgewählt werden.

Expanded Grid/Nudge Display

Bei aktivierter Option Expanded Grid/Nudge 

Display wird der Nudge-Selektor zusätzlich 
zum Grid-Selektor in der Symbolleiste des 
MIDI Editor-Fensters angezeigt.

Als Ziel ausgewähltes MIDI Editor-Fenster

Nicht als Ziel ausgewähltes MIDI Editor-Fenster

Anzeige der erweiterten Edit-Tools in einem 
MIDI Editor-Fenster

Edit-Tool-Popup-Menü

Grid- und Nudge-Selektor
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Selection Display

Bei aktivierter Option Selection Display wird die 
Edit-Selektions-Anzeige in der Symbolleiste des 
MIDI Editor-Fensters angezeigt.

Spurenliste

Bei aktivierter Option Track List wird die Tracks-
Liste im MIDI Editor-Fenster angezeigt.

Scrolling-Untermenü
Im Scrolling-Untermenü können Sie die Scroll-
Optionen für das MIDI Editor-Fenster unabhängig 
von anderen MIDI Editor-Fenstern und vom Edit-
Fenster auswählen. Zu den Scroll-Optionen 
gehören:

Kein Scrollen – das MIDI Editor-Fenster wird 
weder während noch nach der Wiedergabe 
gescrollt. – der Playback-Cursor bewegt sich durch 
das MIDI Editor-Fenster und zeigt die 
Wiedergabeposition an.

Nach Wiedergabe – der Playback-Cursor bewegt 
sich durch das MIDI Editor-Fenster und zeigt die 
Wiedergabeposition an. Wenn die Wiedergabe 
angehalten wird, scrollt das MIDI Editor-Fenster 
an die letzte Wiedergabeposition.

Page – der Playback-Cursor bewegt sich durch das 
MIDI Editor-Fenster und zeigt die 
Wiedergabeposition an. Wenn der rechte Rand des 
MIDI Editor-Fensters erreicht ist, wird sein 
gesamter Inhalt gescrollt und der Playback-Cursor 
bewegt sich weiter vom linken zum rechten 
Fensterrand.

Kontinuierliches – das MIDI Editor-Fenster 
scrollt kontinuierlich hinter dem Playback-Cursor, 
der in der Fenstermitte bleibt. Bei dieser Option 
basiert die Wiedergabe (anders als bei der 
Scrolling-Option Center Playhead) immer auf der 
Timeline-Selektion.

Center Playhead (nur Pro Tools HD) – das MIDI 
Editor-Fenster scrollt kontinuierlich hinter 
dem Playhead, der durch die blaue Linie 
(bzw bei Aufnahme die rote Linie) in der Mitte 
des Fensters dargestellt wird.

Follow Edit Window – mit dieser Option folgt das 
MIDI Editor-Fenster der Scrolling-Option, die für 
das Edit-Fenster ausgewählt wurde (Options > Edit 

Window Scrolling).

Anpassbare Symbolleiste
Sie können die Symbolleiste in MIDI Editor-
Fenstern durch Neuanordnen und Ein- oder 
Ausblenden der verfügbaren Steuerelemente 
und Anzeigen ebenso wie im Edit-Fenster oder 
im Score Editor-Fenster anpassen.

Ändern der Anzeigeoptionen für die 
Symbolleiste

So ändern Sie die Anzeigeoptionen für die 
Symbolleiste in einem MIDI Editor-Fenster:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie im MIDI Editor-Fenster auf das 
Menü für die Symbolleiste.

• Klicken Sie mit der rechten Maustaste auf 
die Symbolleiste.

2 Aktivieren bzw. deaktivieren Sie im Popup-
Menü beliebige der folgenden Optionen:

• Expanded Edit Tools

• Expanded Grid/Nudge Display

• Selection Display

Selektionsanzeige
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Neuanordnen von Steuerelementen 
und Anzeigen

Sie können die Steuerelemente und Anzeigen in 
der Symbolleiste für MIDI Editor-Fenster ebenso 
wie im Edit- oder Score Editor-Fenster neu 
arrangieren.

So ordnen Sie Steuerelemente und Anzeigen einer 
Symbolleiste in einem MIDI Editor-Fenster neu an:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) oder Befehlstaste (Mac) auf die 
Steuerelemente oder Anzeigen, die Sie 
verschieben möchten. Ziehen Sie sie dann an 
die gewünschte Position in der Symbolleiste.

MIDI Editor-Zoom-
Steuerelemente
Schaltflächen für das vertikale und horizontale 
Vergrößern und Verkleinern

Zusätzlich zu den Zoom-Steuerelementen in der 
Symbolleiste bietet Pro Tools Schaltflächen für 
horizontales und vertikales Zoomen in der unteren 
rechten Ecke der MIDI Editor-Fenster. 

Schaltflächen für vertikalen Zoom – 
proportionales Zoomen der Lane-Höhen für 
Automation- und Controller-Lanes

Schaltflächen für horizontalen Zoom – Zoomen 
der Timeline wie mit den Steuerelementen für 
horizontalen Zoom in der Symbolleiste für MIDI 
Editor-Fenster

MIDI-Zoomschaltflächen

In Pro Tools befinden sich Schaltflächen für das 
Heran- und Herauszoomen von MIDI-Daten in der 
oberen rechten Ecke der MIDI Editor-Fenster. 
Diese Steuerelemente funktionieren genauso wie 
die MIDI-Zoom-Steuerelemente in der 
Symbolleiste: Sie können hiermit MIDI-Noten 
vertikal vergrößern und verkleinern.

Schaltflächen für das vertikale und horizontale 
Vergrößern und Verkleinern

MIDI-Zoomschaltflächen
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Spurenliste
Mit der Tracks-Liste in MIDI Editor-Fenstern 
können Sie MIDI-, Instrumenten- und Auxiliary-
Eingangs-Spuren im MIDI Editor-Fenster 
anzeigen. Die Einstellungen der Tracks-Liste sind 
in jedem MIDI Editor-Fenster einzigartig. Die 
Reihenfolge der Spuren in der Tracks-Liste gilt 
jedoch global. Das Sortieren oder Neuanordnen 
von Spuren wirkt sich auf die Tracks-Liste in 
jedem Fenster aus.

Spalten der Tracks-Liste
MIDI Editor-Fenster verfügen über vier Spalten 
für die Tracks-Liste: 

Show/Hide – zeigt an, welche Spuren im MIDI 
Editor-Fenster ein- oder ausgeblendet werden.

Track Color – zeigt die Spurfarbe für jede Spur 
nach Typ oder nach Spur an.

Name – zeigt den Namen jeder Spur an.

Stift – ermöglicht Ihnen, eine Spur für die 
manuelle Eingabe von MIDI-Noten mit dem 
Pencil-Tool freizuschalten.

Menü der Tracks-Liste
Im Menü der Tracks-Liste können Sie MIDI-, 
Instrumenten- und Auxiliary-Eingangs-Spuren im 
MIDI Editor-Fenster anzeigen und ausblenden (siehe 
„Ein- und Ausblenden von Spuren“ auf Seite 743). 

Mithilfe des Tracks-Listen-Menüs können Sie 
außerdem Spuren nach Name, Typ, Edit-Gruppe, 
Mix-Gruppe oder Voice sortieren (siehe „Sortieren 
von Spuren in der Tracks-Liste“ auf Seite 744).

Ein- und Ausblenden von Spuren

So blenden Sie MIDI-, Instrumenten- und Auxiliary-
Eingangs-Spuren in einem MIDI Editor-Fenster ein:

 Aktivieren Sie für die Spuren, die Sie im MIDI 
Editor-Fenster anzeigen möchten, in der 
Tracks-Liste das Symbol zum Ein-/Ausblenden 
von Spuren.

So blenden Sie alle MIDI-, Instrumenten- 
und Auxiliary-Eingangs-Spuren in einem 
MIDI Editor-Fenster ein:

 Wählen Sie im Popup-Menü der Tracks-Liste 
Show All Tracks.

So blenden Sie nur ausgewählte MIDI-, Instrumenten- 
und Auxiliary-Eingangs-Spuren in einem 
MIDI Editor-Fenster ein:

1 Wählen Sie in der Tracks-Liste die MIDI-, 
Instrumenten- und Auxiliary-Eingangs-Spuren 
aus, die Sie im MIDI Editor-Fenster einblenden 
möchten.

2 Wählen Sie im Popup-Menü der Tracks-Liste 
Show Only Selected Tracks.

Spurenliste

Spurname
Spurartsymbol

Farbliche Kennzeichnung
Ein-/Ausblenden von Spuren

Freischalten für das Pencil-Tool

Menü der Tracks-Liste
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So blenden Sie alle Spuren eines einzelnen Typs 
(MIDI-, Instrumenten- oder Auxiliary-Eingangs-
Spuren) in einem MIDI Editor-Fenster ein:

 Wählen Sie im Popup-Menü der Tracks-Liste 
Show Only und wählen Sie den gewünschten 
Spurtyp aus.

So blenden Sie MIDI-, Instrumenten- und Auxiliary-
Eingangs-Spuren in einem MIDI Editor-Fenster aus:

 Deaktivieren Sie für die Spuren, die Sie 
im MIDI Editor-Fenster ausblenden möchten, 
in der Tracks-Liste das Symbol zum 
Ein-/Ausblenden von Spuren.

So blenden Sie alle MIDI-, Instrumenten- 
und Auxiliary-Eingangs-Spuren (außer einer) 
in einem MIDI Editor-Fenster aus:

 Wählen Sie im Popup-Menü der Tracks-Liste 
Hide All Tracks. 

Alle MIDI- oder Instrumentenspuren in der 
Tracks-Liste bis auf die oberste werden 
ausgeblendet. In MIDI Editor-Fenstern muss 
immer mindestens eine MIDI- oder 
Instrumentenspur angezeigt werden.

So blenden Sie ausgewählte MIDI-, Instrumenten- 
und Auxiliary-Eingangs-Spuren in einem 
MIDI Editor-Fenster aus:

1 Wählen Sie in der Tracks-Liste die MIDI-, 
Instrumenten- und Auxiliary-Eingangs-Spuren 
aus, die Sie ausblenden möchten.

2 Wählen Sie im Popup-Menü der Tracks-Liste 
Hide Selected Tracks.

Sortieren von Spuren in der 
Tracks-Liste
Sie können Spuren in der Tracks-Liste nach den 
folgenden Kriterien sortieren:

Name – sortiert die Spur-Reihenfolge in der 
Tracks-Liste nach dem Spurnamen.

Typ – sortiert die Spur-Reihenfolge in der Tracks-
Liste nach der Spurart.

Edit Group – sortiert die Spur-Reihenfolge in der 
Tracks-Liste nach Edit-Gruppen.

Mix Group – sortiert die Spur-Reihenfolge in der 
Tracks-Liste nach Mix-Gruppen.

Voice – sortiert die Spur-Reihenfolge in der 
Tracks-Liste nach Voice-Zuweisungen.

Kontextmenü in der Tracks-Liste
Zusätzlich zu den allgemeinen Befehlen zur 
Spurenverwaltung verwendet das Kontextmenü in 
der Tracks-Liste Befehle gemeinsam mit dem 
Tracks-Listen-Popup-Menü und dem 
Kontextmenü des Notes-Fensterbereichs.

So rufen Sie das Kontextmenü der Tracks-Liste im 
MIDI Editor auf:

 Klicken Sie mit der rechten Maustaste auf einen 
beliebigen Spurnamen in der Tracks-Liste.

Optionen im Kontextmenü der Tracks-Liste

Je nach Spurart (Auxiliary-Eingangs-, 
Instrumenten- oder MIDI-Spur) stehen die 
folgenden Optionen zur Verfügung.

Hide – blendet die ausgewählte Spur aus.

Ausblenden und deaktivieren – blendet die 
ausgewählte Spur aus und deaktiviert sie.

Make Inactive – deaktiviert die ausgewählte Spur.
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MIDI exportieren – exportiert die ausgewählte 
Spur als MIDI-Datei.

New – öffnet das New Track-Dialogfeld.

Rename – benennt die ausgewählte Spur um.

Duplicate – dupliziert die ausgewählte Spur.

In Monospuren teilen – teilt die ausgewählte 
Stereo-Instrumenten- oder -Auxiliary-Eingangs-
Spur in zwei Monospuren auf.

Delete – löscht die ausgewählte Spur.

MIDI-Echtzeiteigenschaften – öffnet das Fenster 
„MIDI Real-Time Properties“ für die ausgewählte 
Spur.

In MIDI-Editor öffnen – öffnet die im aktuellen 
MIDI Editor-Fenster angezeigten Spuren in einem 
neuen MIDI Editor-Fenster. Das neue MIDI 
Editor-Fenster wird nicht als Ziel ausgewählt.

In Noten-Editor öffnen – öffnet die angezeigten 
Spuren im Score Editor-Fenster.

In MIDI-Event-Liste öffnen – öffnet die 
ausgewählte Spur in der MIDI Event-Liste.

Spureinstellungen in der Notationsanzeige – 
öffnet das Fenster „Notation Display Track Settings“.

Gruppenliste
Die Groups-Liste im MIDI Editor bietet dieselben 
Funktionen wie im Edit-Fenster. Sie können 
mithilfe der Groups-Liste in jedem beliebigen 
MIDI Editor-Fenster Edit-Gruppen erstellen, 
bearbeiten und löschen. Die Groups-Liste ist 
zwischen dem Edit-Fenster und sämtlichen MIDI 
Editor-Fenstern gekoppelt.

Zeitbasis- und Dirigentleisten
Zeitbasis- und Dirigentleisten funktionieren in MIDI 
Editor-Fenstern und im Edit-Fenster gleich. 
Allerdings können das Edit-Fenster und die 
einzelnen MIDI Editor-Fenster einzigartige 
Darstellungen der Timeline hinsichtlich der Anzeige 
von Zeitbasis- und Dirigentenleisten sowie bei der 
Zoomstufe und Zeitposition aufweisen. 

Informationen zum Gruppieren von Spuren 
finden Sie unter Kapitel 14: „Gruppieren 
von Spuren“.
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Darstellung überkopierter 
Noten
Im Notes-Fensterbereich in MIDI Editor-Fenstern 
können Sie MIDI-Noten, die aus anderen MIDI- und 
Instrumentenspuren überkopiert wurden, anzeigen 
und bearbeiten, sodass Sie leicht Multitrack-
Arrangements in einer einzelnen Zusammenstellung 
verschiedenfarbiger Noten editieren können. Sie 
können in dem Fensterbereich MIDI-Noten auf 
dieselbe Art und Weise wie in der Notendarstellung 

für MIDI- und Instrumentenspuren im Edit-Fenster 
bearbeiten, mit dem Unterschied, dass Sie hier auch 
MIDI-Noten auf mehreren MIDI- und 
Instrumentenspuren gleichzeitig bearbeiten können.

Sie können auch MIDI-Noten in der 
Notationsdarstellung des Notes-
Fensterbereichs anzeigen und bearbeiten 
(siehe „Notationsdarstellung“ auf 
Seite 751).

MIDI Editor-Fenster, Notes-Fensterbereich mit fünf überkopierten Instrumentenspuren
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Farbliche Kennzeichnung von MIDI-Noten
Sie können MIDI-Noten nach Spur oder Velocity-Wert farblich kennzeichnen.

Farbliche Kennzeichnung nach Spur

Wenn die farbliche Kennzeichnung nach Spur aktiviert ist, wird den Spuren im MIDI Editor-Fenster 
vorübergehend eine der 16 festgelegten Farben zugewiesen (anhand der Reihenfolge in der Tracks-Liste).

So kennzeichnen Sie MIDI-Noten nach Spur farblich:

 Aktivieren Sie die Schaltfläche „Color Code MIDI Notes By Track“.

Farbliche Kennzeichnung nach Velocity-Wert

Wenn die farbliche Kennzeichnung nach Velocity-Wert aktiviert ist, erhalten alle MIDI-Noten auf allen 
angezeigten Spuren eine rote Kennzeichnung, die basierend auf den Note-On-Velocity-Werten in der 
Farbsättigung variiert (von hell- bis dunkelrot). Noten mit niedrigen Velocity-Werten sind heller als die 
mit höheren Velocity-Werten.

So kennzeichnen Sie MIDI-Noten nach Velocity-Wert farbig:

 Aktivieren Sie die Schaltfläche „Color Code MIDI Notes By Velocity“.

„Color Code MIDI Notes By Track“ im MIDI Editor-Fenster aktiviert

„Color Code MIDI Notes By Velocity“ im MIDI Editor-Fenster aktiviert
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Keine farbliche Kennzeichnung

Wenn weder die farbliche Kennzeichnung nach Spur noch die nach Velocity-Werten aktiviert ist, werden 
Noten im MIDI Editor in derselben Farbe wie im Edit-Fenster geschrieben. Dabei werden die 
Farbkennzeichnungsoptionen aus den Display-Voreinstellungen unter „Track Color Coding“ verwendet.

Editieren von MIDI-Noten
Sie können jede Note auf jeder Spur, die im Notes-
Fensterbereich angezeigt wird, bearbeiten. 
Das Editieren von MIDI-Noten im Notes-
Fensterbereich erfolgt genauso wie in der 
Notendarstellung für MIDI- und Instrumentenspuren 
im Edit-Fenster, außer dass Noten aus verschiedenen 
Spuren überkopiert werden. 

Manuelles Einfügen von 
MIDI-Noten
Mithilfe des Pencil-Tools können Sie MIDI-Noten 
im Notes-Fensterbereich manuell in jede für das 
Pencil-Tool freigeschaltete Spur einfügen. Wenn nur 
eine Spur im MIDI Editor-Fenster angezeigt wird, 
wird diese Spur automatisch für das Pencil-Tool 
freigeschaltet. Wenn im Notes-Fensterbereich 
mehrere überkopierte Spuren angezeigt werden, 
werden MIDI-Noten nur auf der für das Pencil-Tool 
freigeschalteten Spur eingefügt.

So fügen Sie MIDI-Noten in einer bestimmten 
Spur im Notes-Fensterbereich ein:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie die Spur, die für das Pencil-Tool 
freigeschaltet werden soll, mit dem Track Edit-
Selektor in der Symbolleiste aus.

• Klicken Sie auf die Pencil-Spalte in der Tracks-
Liste, um die gewünschte Spur für das Pencil-
Tool freizuschalten.

Keine farbliche Kennzeichnung im MIDI Editor-Fenster aktiviert

Weitere Informationen zum Editieren von 
MIDI-Noten finden Sie unter Kapitel 31: 
„Editieren von MIDI-Daten“.

Weitere Informationen zum manuellen 
Einfügen von MIDI-Noten finden Sie unter 
„Einfügen von MIDI-Noten“ auf Seite 698.

Selektieren einer Spur zum Editieren

Nur Spuren, die aktuell im MIDI Editor-
Fenster angezeigt werden, sind im Popup-
Menü des Track Edit-Selektors verfügbar.

„Blad Pad Midi“-Spur, für das Pencil-Tool freigeschaltet
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2 Klicken Sie mit dem Pencil-Tool auf eine 
Zeitposition und Tonhöhe, um eine MIDI-Note 
auf der für das Pencil-Tool freigeschalteten 
Spur mit dem standardmäßigen Velocity-Wert 
für Notenanfänge und der ausgewählten 
Standardnotendauer einzufügen.

Kontextmenü im Notes-
Fensterbereich
Im Kontextmenü des Notes-Fensterbereichs 
stehen verschiedene hilfreiche Befehle zum 
Bearbeiten, Exportieren und Anzeigen von MIDI-
Daten zur Verfügung.

So rufen Sie das Kontextmenü des MIDI Editor auf:

 Klicken Sie mit der rechten Maustaste auf eine 
beliebige Stelle im Notes-Fensterbereich.

Optionen im Kontextmenü des 
Notes-Fensterbereich

Tools

Im Tools-Untermenü können Sie sämtliche für den 
Score-Editor relevanten Edit-Tools aktivieren.

Zoomer – aktiviert das Zoomer-Tool.

Trim – aktiviert das Trim-Tool.

Selector – aktiviert das Selector-Tool.

Grabber – aktiviert das Grabber-Tool.

Scrubber – aktiviert das Scrubber-Tool.

Stift – aktiviert das Pencil-Tool.

Smart – aktiviert das Smart-Tool.

Zoomer Tools – lässt Sie zwischen dem normalen 
und einfachen Zoom-Modus wählen.

Pencil Tools – lässt Sie unter den Pencil-Tools 
wählen.

Insert

Über das Insert-Untermenü können Sie Tonart- und 
Taktartänderungen sowie Akkordsymbole an der 
jeweiligen Position des Edit-Cursors einfügen.

Key – fügt einen Tonartwechsel ein.

Pegelanzeige – fügt einen Taktartwechsel ein.

Akkord – fügt ein Akkordsymbol ein.

Ausschneiden

Mit dem Cut-Befehl wird die aktuelle Edit-
Selektion ausgeschnitten.

Copy

Mit dem Copy-Befehl wird die aktuelle Edit-
Selektion kopiert.

Einfügen einer MIDI-Note auf Spur „Inst 3“ 

Um mehrere angrenzende Spuren für das Pencil-
Tool freizuschalten, halten Sie die Umschalttaste 
gedrückt und wählen Sie den gewünschten 
Spurenbereich durch Klicken in der Pencil-Spalte 
aus. Um mehrere nicht angrenzende Spuren für 
das Pencil-Tool freizuschalten, klicken Sie bei 
gedrückter Strg-Taste (Windows) oder 
Befehlstaste (Mac) in der Pencil-Spalte auf die 
entsprechenden Spuren. Klicken Sie bei 
gedrückter Alt-Taste (Windows) oder Wahltaste 
(Mac), um alle Spuren für das Pencil-Tool 
freizuschalten. Manuell eingefügte Noten werden 
in alle für das Pencil-Tool freigeschalteten 
Spuren geschrieben.
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Paste

Mit dem Paste-Befehl wird der Inhalt der 
Zwischenablage in die aktuelle Edit-Selektion oder 
an der aktuellen Position des Edit-Cursors eingefügt. 
Sämtliche bereits zuvor an der Position vorhandenen 
MIDI-Noten werden überschrieben.

Zusammenführen

Mit dem Merge-Befehl wird der Inhalt der 
Zwischenablage in die aktuelle Edit-Selektion 
oder an der aktuellen Position des Edit-Cursors 
eingefügt. Die eingefügten Daten werden mit 
bereits an derselben Position vorhandenen MIDI-
Noten zusammengeführt.

Clear

Mit dem Clear-Befehl wird die aktuelle Edit-
Selektion gelöscht.

Trennen

Der Separate-Befehl ermöglicht Ihnen 
das Separieren von MIDI-Noten an der Position 
des Edit-Cursors.

Konsolidieren

Mit dem Consolidate-Befehl können Sie mehrere 
aufeinanderfolgende MIDI-Noten derselben 
Tonhöhe zusammenfassen.

Noten stummschalten

Mit dem Befehl Mute Notes (oder Unmute Notes) 
können Sie selektierte MIDI-Noten stummschalten 
(bzw. deren Stummschaltung aufheben).

MIDI-Echtzeiteigenschaften

Über die Option MIDI Real-Time Properties wird 
das gleichnamige Fenster geöffnet.

Event-Vorgänge

Im Untermenü „Event Operations“ können Sie die 
verschiedenen Event Operations-Fenster (etwa 
„Quantize“ oder „Change Velocity“) auswählen.

Open In New MIDI Editor

Durch Aktivieren von Open In New MIDI Editor 
werden alle angezeigten Spuren in einem neuen 
MIDI Editor-Fenster geöffnet.

Open In Score Editor

Die Option Open In Score Editor öffnet die 
eingeblendeten Spuren im Score Editor-Fenster.

In MIDI-Event-Liste öffnen

Mit der Option Open In MIDI Event List wird die 
ausgewählte Spur in der MIDI Event-Liste geöffnet.

Notation anzeigen

Durch Aktivieren von Display Notation wechseln 
Sie im MIDI Editor zur Notationsdarstellung. 
Durch Deaktivieren dieser Option kehren Sie zur 
Notendarstellung zurück.
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Notationsdarstellung
Im Notes-Fensterbereich in MIDI Editor-Fenstern können MIDI-Noten auch in Standardnotenschrift 
angezeigt werden. In der Notationsdarstellung wird jede MIDI- und Instrumentenspur eigenständig 
angezeigt, mit einer Spur pro Notenzeile. 

In MIDI Editor-Fenstern wird die Notation 
als fortlaufende Timeline und nicht wie 
im Score Editor-Fenster in einer 
Seitendarstellung dargestellt. 

Zur Aktivierung der Notationsdarstellung haben 
Sie folgende Möglichkeiten:

 Aktivieren Sie die Schaltfläche „Notation 
View“ in der Symbolleiste des MIDI Editor-
Fensters.

 Klicken Sie mit der rechten Maustaste im Notes-
Fensterbereich und wählen Sie Notation View.

MIDI Editor-Fenster, Notes-Fensterbereich in der Notationsdarstellung

Weitere Informationen zum Editieren 
der Notation finden Sie unter „Editieren von 
Noten“ auf Seite 769.

Notationsdarstellung in einem MIDI Editor-
Fenster aktiviert
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Das Editieren in der Notationsdarstellung eines 
MIDI Editor-Fensters funktioniert genauso wie im 
Score Editor-Fenster, allerdings mit dem Vorteil, 
dass Sie Zugriff auf die Velocity-, Controller- und 
Automation-Lanes haben. 

Double Bar-Option in 
der Notationsdarstellung
Die Schaltfläche „Double Bar“ steht nur in der 
Notationsdarstellung zur Verfügung. Bei aktivierter 
Double Bar-Option wird der letzte, doppelte 
Taktstrich im MIDI Editor-Fenster angezeigt. 
Der doppelte Taktstrich befindet sich am Ende des 
letzten MIDI-Clips bzw. -Events in der Session.

Wenn die Double Bar-Option deaktiviert ist, wird am 
Ende des letzten Events der Session eine Reihe leerer 
Takte angezeigt. Die Anzahl leerer Takte hängt dabei 
von der Einstellung Additional Empty Bars In The 

Score Editor auf der MIDI Preferences-Registerkarte 
ab (Setup > Preferences). Deaktivieren Sie die 
Double Bar-Option, um im Score Editor manuell 
Noten nach dem letzten MIDI-Clip bzw. -Event der 
Session einzugeben.

Kontextmenü in der 
Notationsdarstellung
In der Notationsdarstellung bietet das Kontextmenü 
des Notes-Fensterbereichs leicht abweichende 
Optionen im Vergleich zur Darstellung überkopierter 
Noten (Superimposed Notes). 

Folgende Optionen stehen in beiden Darstellungen 
zur Verfügung:

• Tools

• Insert

• Ausschneiden

• Copy

• Paste

• Clear

• Trennen

• Konsolidieren

• Stummschaltung

• MIDI-Echtzeiteigenschaften

• Event-Vorgänge

• Open In New MIDI Editor

• Open In Score Editor

• Open In MIDI Event List

• Notation anzeigen

In der Notationsdarstellung steht außerdem 
die Option Notation Display Track Settings 
im Kontextmenü zur Verfügung. Wählen 
Sie diese Option aus, um das Dialogfeld 
„Notation Display Track Settings“ zu öffnen 
und die Anzeigeeinstellungen für Spuren in der 
Notationsdarstellung zu konfigurieren. Weitere 
Informationen zum Dialogfeld „Notation Display 
Track Settings“ finden Sie unter „Notation Display 
Track Settings“ auf Seite 766.

In der Notationsdarstellung funktioniert das 
Trim-Tool beim Bewegen über eine Note als 
Grabber-Tool und als Note Selector-Tool, 
wenn es sich nicht über einer Note befindet.

In der Notationsdarstellung wird der Edit-
Modus automatisch auf „Grid“ festgelegt 
und kann nicht geändert werden.

„Double Bar“ in einem MIDI Editor-Fenster aktiviert
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Velocity-, Controller- und Automation-Lanes
In MIDI Editor-Fenstern können Sie Velocity-Werte, MIDI-Controller-Daten und die Automation für alle MIDI-, 
Instrumenten- und Auxiliary-Eingangs-Spuren in Lanes unter dem Notes-Fensterbereich bearbeiten.

Sie können die Automation- und Controller-Lanes 
wie im Edit-Fenster verschieben und ihre Größe 
ändern.

Bei der Anzeige mehrerer MIDI- und 
Instrumentenspuren werden die Velocity-Werte 
für Noten auf verschiedenen Spuren in eine 
einzelne Lane überkopiert, ebenso wie Noten im 
Notes-Fensterbereich. Alle anderen Controller-
Lanes werden jedoch nach Automation- und 
Controller-Typ gruppiert und bieten individuelle 
Lanes für jede angezeigte Spur.

So blenden Sie Lanes unterhalb des Notes-
Fensterbereichs ein oder aus:

 Klicken Sie auf die Schaltfläche zum Ein-/ 
Ausblenden von Lanes.

So fügen Sie Lanes hinzu:

 Klicken Sie auf die Schaltfläche zum 
Hinzufügen der Lane.

So entfernen Sie Lanes:

 Klicken Sie auf die Schaltfläche zum Entfernen 
der Lane.

So ändern Sie den Automations- oder 
Controllertyp für eine Lane:

 Klicken Sie auf den Automation- bzw. Controller-
Typ-Selektor und wählen Sie den gewünschten 
Automation- oder Controller-Typ aus.

Velocity-, Controller- und Automation-Lanes für zwei Stereo-Instrumentenspuren

 

Lanes 
ein-/ausblenden

Velocity-Lane 
(2 Spuren 
überkopiert)

Lane entfernen
Lane 

hinzufügen

Controller/Automation-
Typ-Selektor

Automation-Lane-
Paar für separate 
Spuren
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Kapitel 33: Score Editor

Im Score Editor-Fenster können Sie MIDI-Daten aus Ihrer Session in Notenschrift anzeigen, editieren, 
arrangieren und drucken. MIDI-Noten werden unabhängig davon, ob sie aufgenommen, importiert, 
geschrieben (mit dem Pencil-Tool) oder über „Step Input“ eingegeben werden, in Echtzeit transkribiert. 

Score Editor-Fenster

Edit-Tools

Default Note Duration

Default Note Velocity

Play MIDI Notes While Editing

Mirrored MIDI Editing

Link Timeline and Edit Selection

Double Bar
Cursor-Position

Score Editor-Menü

Target

(Ziel)
Selection

Grid-Selektor

Spurenliste
Page-Steuerelemente Zoom-Steuerelemente
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Öffnen des Score Editor-
Fensters
So öffnen Sie das Score Editor-Fenster:

 Wählen Sie Window > Score Editor.

So öffnen Sie das Score Editor-Fenster mit einer 
einzelnen angezeigten MIDI- oder 
Instrumentenspur:

1 Stellen Sie sicher, dass keine Edit-Selektion 
vorhanden ist.

2 Klicken Sie mit der rechten Maustaste auf den 
Spurnamen einer nicht selektierten Spur im 
Edit- oder Mix-Fenster oder in der Tracks-Liste 
des Edit-, Mix- oder MIDI Editor-Fensters.

3 Wählen Sie im Kontextmenü die Option Open 

In Score Editor.

So öffnen Sie das Score Editor-Fenster mit der 
aktuell angezeigten Edit-Selektion:

1 Treffen Sie im Edit- oder in einem MIDI Editor-
Fenster auf einer oder mehreren Spuren eine 
Edit-Selektion mit dem Material, das im Score 
Editor-Fenster angezeigt werden soll.

2 Klicken Sie mit der rechten Maustaste auf die 
Edit-Selektion und wählen Sie Open In Score 

Editor.

Edit-Tools
Die Edit-Tools im Score Editor-Fenster 
funktionieren größtenteils genauso wie im Edit-
Fenster, aber mit einigen Unterschieden beim 
Editieren von Notenschrift.

Zoomer
Mit dem Zoomer-Tool können Sie einen bestimmten 
Bereich in der Partitur vergrößern und verkleinern. 

Das Zoomer-Tool kann in zwei Modi verwendet 
werden: 

Normal Zoom-Modus – das Zoomer-Tool bleibt 
nach dem Zoomen ausgewählt. 

Single Zoom-Modus – nach dem Zoomen ist das 
zuvor verwendete Edit-Tool wieder aktiv.

Normal Zoom-Modus

So zoomen Sie den Bereich um eine bestimmte 
Position in der Partitur:

1 Wählen Sie im Popup-Menü des Zoomer-Tools 
den normalen Zoom-Modus.

2 Klicken Sie einmal mit dem Zoomer-Tool auf 
die Position in der Partitur. Die Partitur wird um 
eine Stufe vergrößert und die Anzeige wird auf 
den vergrößerten Bereich zentriert.

3 Klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) erneut mit 
dem Zoomer-Tool, um zur vorherigen 
Zoomstufe zurückzukehren.

Drücken Sie Alt + Windows + „=“ 
(Windows) bzw. Wahl + Ctrl + „=“ (Mac), 
um das Score Editor-Fenster anzuzeigen.

Wenn auf der MIDI Preferences-
Registerkarte als Score Editor-Option die 
Einstellung „Double Clicking a MIDI Clip 
Opens“ ausgewählt wurde, können Sie auf 
einen MIDI-Clip doppelklicken, um ihn im 
Score Editor-Fenster zu öffnen.

Drücken Sie die Taste F5, um das Zoomer-Tool 
auszuwählen und zwischen dem normalen und 
einfachen Zoom-Modus zu wechseln.

Weitere Informationen finden Sie unter 
„Score Editor-Zoom-Steuerelemente“ auf 
Seite 765
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So vergrößern Sie einen bestimmten Bereich der 
Partitur mit dem Fadenkreuz:

1 Wählen Sie im Popup-Menü des Zoomer-Tools 
den normalen Zoom-Modus.

2 Ziehen Sie in der Partitur einen Auswahlrahmen 
um den Bereich, den Sie vergrößern möchten.

Der vergrößerte Bereich füllt das Edit-Fenster aus.

Single Zoom-Modus 

Im einfachen Zoom-Modus ist automatisch nach 
dem Zoomen das zuvor ausgewählte Tool wieder 
aktiv.

Wenn Sie etwa das Pencil-Tool verwenden, 
können Sie das einfache Zoomer-Tool auswählen. 
Nach dem Zoomen wechselt Pro Tools 
automatisch wieder zum Pencil-Tool.

Der einfache Zoom-Modus ist am Pfeil rechts 
neben dem Zoomer-Symbol zu erkennen. (Im 
normalen Zoom-Modus wird kein Pfeil angezeigt.)

So verwenden Sie den einfachen Zoom-Modus:

 Wählen Sie im Popup-Menü des Zoomer-Tools 
den einfachen Zoom-Modus.

Trim
Mit dem Trim-Tool können Sie die Dauer einer 
Note im Score Editor-Fenster verlängern oder 
verkürzen.

Note Selector
Mit dem Note Selector-Tool können Sie Noten auf 
einer oder mehreren Notenzeilen im Score Editor-
Fenster selektieren. Selektierte Noten werden blau 
hervorgehoben. Sie können selektierte Noten 
löschen, verschieben, transponieren und 
verarbeiten (mithilfe von Event-Vorgängen) 

Grabber
Mit dem Grabber-Tool können Sie Noten auf einer 
oder mehreren Notenlinien im Score Editor-
Fenster selektieren. Sie können das Grabber-Tool 
auch verwenden, um einzelne Noten oder alle 
selektierten Noten hinsichtlich der Tonhöhe oder 
der zeitlichen Position zu verschieben.

Zoomen mit Fadenkreuz und Zoomer-Tool

Drücken Sie F6, um das Trim-Tool 
auszuwählen.

Drücken Sie F7, um das Note Selector-Tool 
auszuwählen.

Mit dem Note Selector-Tool wird eine 
Bereichsselektion getroffen, die lediglich 
MIDI-Noten und Velocity-Werte beinhaltet. 
Die Selektion enthält keine weiteren MIDI-
Daten, wie etwa Program Changes oder 
Continuous Controller-Daten. 

Drücken Sie F8, um das Grabber-Tool 
auszuwählen.
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Pencil
Mit den Pencil-Tools können Sie Noten im Score 
Editor-Fenster einfügen, selektieren, verschieben 
oder löschen. Die verschiedenen Pencil-Tools 
unterscheiden sich darin, wie Tondauer, 
wiederholte Noten und Velocity-Werte 
geschrieben werden. Ihre Funktionsweise ist aber 
dieselbe wie beim Schreiben von Noten auf Spuren 
in der Notendarstellung im Edit-Fenster oder 
einem MIDI Editor-Fenster.

So wählen Sie ein Pencil-Tool:

 Klicken Sie auf das Pencil-Popup-Menü und 
wählen Sie das gewünschte Pencil-Tool aus.

Die folgenden Pencil-Tools stehen im Score Editor 
zur Verfügung:

Free Hand

Mit dem Pencil-Tool Free Hand können Sie 
einzelne Noten unterschiedlicher Dauer zeichnen. 

Velocity-Werte von Noten werden durch die 
Einstellung „Default Note Velocity“ bestimmt 
(siehe „Default Note On Velocity“ auf Seite 759). 

Die Mindestdauer der Note wird durch den Wert 
von „Default Note Duration“ bestimmt (siehe 
„Default Note Duration“ auf Seite 759).

Zeile

Das Pencil-Tool Line ermöglicht das Schreiben 
mehrerer Noten derselben Tonhöhe und Dauer. 

Velocity-Werte von Noten werden durch die 
Einstellung „Default Note Velocity“ bestimmt 
(siehe „Default Note On Velocity“ auf Seite 759). 

Die Dauer wird durch den Wert von „Default Note 
Duration“ bestimmt (siehe „Default Note 
Duration“ auf Seite 759). 

Die Startzeit für jede Note wird durch den 
ausgewählten Rasterwert (Grid Value) bestimmt 
(siehe „Raster“ auf Seite 761).

Triangle

Mit dem Pencil-Tool Triangle können Sie eine 
Reihe von MIDI-Noten auf derselben Tonhöhe 
schreiben, deren Velocity-Werte zwischen dem 
festgelegten Velocity-Standardwert für Töne und 
127 in einem Dreiecksmuster schwanken. 
Die Dauer jeder Note wird durch den aktuellen 
Rasterwert (Grid Value) bestimmt.

Die Dauer wird durch den Wert von „Default Note 
Duration“ bestimmt (siehe „Default Note 
Duration“ auf Seite 759). 

Die Startzeit für jede Note wird durch den 
ausgewählten Rasterwert (Grid Value) bestimmt 
(siehe „Raster“ auf Seite 761).

Square

Mit dem Pencil-Tool Square können Sie eine 
Reihe von MIDI-Noten auf derselben Tonhöhe 
schreiben, deren Velocity-Werte zwischen dem 
festgelegten Velocity-Standardwert für Töne und 
127 in einem Rechteckmuster schwanken. Die 
Dauer jeder Note wird durch den aktuellen 
Rasterwert (Grid Value) bestimmt.

Die Dauer wird durch den Wert von „Default Note 
Duration“ bestimmt (siehe „Default Note 
Duration“ auf Seite 759). 

Die Startzeit für jede Note wird durch den 
ausgewählten Rasterwert (Grid Value) bestimmt 
(siehe „Raster“ auf Seite 761).

Drücken Sie wiederholt F10, um durch die 
verschiedenen Pencil-Tools zu blättern.
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Random

Mit dem Pencil-Tool Random können Sie eine 
Reihe von MIDI-Noten auf derselben Tonhöhe 
schreiben, deren Velocity-Werte zufällig im 
Bereich zwischen dem festgelegten Velocity-
Standardwert für Töne und 127 in einem 
Rechteckmuster schwanken. Die Dauer jeder Note 
wird durch den aktuellen Rasterwert (Grid Value) 
bestimmt.

Die Dauer wird durch den Wert von „Default Note 
Duration“ bestimmt (siehe „Default Note 
Duration“ auf Seite 759). 

Die Startzeit für jede Note wird durch den 
ausgewählten Rasterwert (Grid Value) bestimmt 
(siehe „Raster“ auf Seite 761).

Default Note Duration
Mit dem Selektor „Default Note Duration“ können 
Sie die Standardnotendauer für manuell eingefügte 
Noten festlegen.

So legen Sie die Standardnotendauer fest:

 Wählen Sie im Selektor „Default Note 
Duration“ einen Notenwert aus. Aktivieren Sie 
die Option „Follow Grid“, wenn die 
Standardnotendauer sich am ausgewählten 
Rasterwert (Grid Value) orientieren soll.

Wenn Sie punktierte Notenwerte möchten, 
aktivieren Sie auch die Option „Dotted“.

Wenn Sie triolische Notenwerte möchten, 
aktivieren Sie auch die Option „Triplet“.

Default Note On Velocity
Mit der Einstellung „Default Note On Velocity“ 
können Sie den Velocity-Standardwert für 
Notenanfänge manuell eingefügter Noten 
festlegen.

Play MIDI Notes When 
Editing
Wenn diese Option aktiviert ist, werden die 
entsprechenden MIDI-Noten beim Einfügen mit 
dem Pencil-Tool oder Ziehen mit dem Grabber-
Tool abgespielt. 

Link Timeline and Edit 
Selection
Wenn diese Schaltfläche aktiviert ist, sind 
Timeline- und Edit-Selektion gekoppelt. Ist die 
Schaltfläche deaktiviert, können Sie die Timeline- 
und Edit-Selektion unabhängig voneinander 
vornehmen.

Selektor „Default Note Duration“

„Play MIDI Notes When Editing“ im Score Editor-
Fenster aktiviert

„Link Timeline and Edit Selection“ im Score Editor-
Fenster aktiviert
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Mirrored MIDI Editing
Mit dem sogenannten Mirrored MIDI Editing 
können Sie MIDI-Clips editieren und die 
Änderungen auf alle Kopien eines MIDI-Clips 
anwenden. Dies kann besonders beim Editieren 
von geloopten MIDI-Clips zweckdienlich sein.

Im Mirrored MIDI Editing-Modus blinkt die 
Mirrored MIDI Editing-Schaltfläche einmal rot, 
wenn ein Editiervorgang ausgeführt wird. Dies ist 
ein Zeichen dafür, dass der Vorgang auf mehr als 
einen Clip angewendet wird.

Um „Mirrored MIDI Editing“ zu aktivieren, haben 
Sie folgende Möglichkeiten:

 Aktivieren Sie Options > Mirror MIDI Editing.

 Aktivieren Sie die Schaltfläche „Mirrored 
MIDI Editing“ im Edit-Fenster, MIDI Editor-
Fenster oder Score Editor-Fenster.

Um „Mirrored MIDI Editing“ zu deaktivieren, haben 
Sie folgende Möglichkeiten:

 Deaktivieren Sie Options > Mirror MIDI Editing.

 Deaktivieren Sie die Schaltfläche „Mirrored 
MIDI Editing“ im Edit-Fenster, MIDI Editor-
Fenster oder Score Editor-Fenster.

Double Bar
Bei aktivierter Double Bar-Option wird der letzte, 
doppelte Taktstrich im Score Editor-Fenster 
angezeigt. Der doppelte Taktstrich befindet sich 
am Ende des letzten MIDI-Clips bzw. -Events in 
der Session. Aktivieren Sie die Double Bar-
Option, wenn Sie bereit sind, die Partitur zu 
drucken.

Wenn die Double Bar-Option deaktiviert ist, wird 
am Ende des letzten MIDI-Clips der Session eine 
Reihe leerer Takte angezeigt. Die Anzahl leerer 
Takte hängt dabei von der Einstellung Additional 

Empty Bars In The Score Editor auf der MIDI 
Preferences-Registerkarte von Pro Tools ab 
(Setup > Preferences). Deaktivieren Sie die 
Double Bar-Option, um im Score Editor manuell 
Noten nach dem letzten MIDI-Clip einzugeben.

Cursor-Position
In der Anzeige zur Cursor-Position werden 
Informationen zur aktuellen Position des Cursors 
in Bars|Beats|Ticks und Tonhöhe bereitgestellt.

„Mirrored MIDI Editing“ im Score Editor-Fenster 
deaktiviert

Wenn der Mirrored MIDI Editing-Modus 
deaktiviert ist und Sie Noten geloopter Clips 
in der Notendarstellung editieren, wird beim 
Edit-Vorgang der Loop in Clips 
umgewandelt. In ähnlicher Weise führt das 
Editieren von Clip-Gruppen dazu, dass die 
Gruppen separiert werden.

„Double Bar“ im Score Editor-Fenster aktiviert

Cursor-Positionsanzeige im Score Editor-Fenster
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Raster
Mit dem Grid Value-Selektor können Sie den 
Rasterwert (Grid Value) für MIDI-Noten 
festlegen, die im Score Editor-Fenster eingefügt 
und angezeigt werden. 

So legen Sie den Rasterwert für das Score Editor-
Fenster fest:

 Wählen Sie im Grid Value-Popup-Menü einen 
Notenwert.

Wenn Sie punktierte Notenwerte möchten, 
aktivieren Sie auch die Option „Dotted“.

Wenn Sie triolische Notenwerte möchten, 
aktivieren Sie auch die Option „Triplet“.

Einfügen von Noten im Raster
Beim Einfügen von MIDI-Noten mit dem Pencil-
Tool (mithilfe der Formen „Line“, „Triangle“, 
„Square“ und „Random“) bestimmt der Rasterwert 
die Position des Notenanfangs und der Wert für 
„Default Note Duration“ bestimmt die Notendauer 
(siehe „Default Note Duration“ auf Seite 759). 

Wenn beispielsweise „Default Note Duration“ auf 
Viertelnoten gesetzt wurde und das Raster auf 
Halbnoten festgelegt wird, werden beim Zeichnen 
mit dem Pencil-Tool Line Viertelnoten erstellt.

Sollte der ausgewählte Rasterwert kürzer sein 
als die Standardnotendauer, so bestimmt der 
Rasterwert sowohl die Position des Notenanfangs 
als auch die Notendauer für Noten, die mit dem 
Pencil-Tool eingefügt wurden. Wenn 
beispielsweise „Default Note Duration“ auf 
Viertelnoten gesetzt wurde und das Raster auf 
Achtelnoten festgelegt wird, wird beim Zeichnen 
mit dem Pencil-Tool Line eine 
Achtelnotensequenz erstellt.

Target-Option für das Score 
Editor-Fenster
Wenn die Target-Option für das Score Editor-
Fenster aktiviert ist, wird beim Navigieren im 
Edit-Fenster automatisch auch im Score Editor-
Fenster navigiert. Wenn Sie also beispielsweise im 
Edit-Fenster zu Takt 32 und Taktschlag 3 in einer 
MIDI-Spur navigieren, wird beim Anzeigen des 
Score Editor-Fensters dieselbe Position angezeigt.

Wenn die Target-Option deaktiviert ist, wird der 
Score Editor nicht entsprechend der aktuellen 
Selektion oder Cursor-Position im Edit-Fenster 
aktualisiert.

Einstellen des Rasterwerts

Einfügen von Noten im Raster
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Score Editor-Fenstermenü
Über das Menü im Score Editor-Fenster erhalten 
Sie Zugriff auf erweiterte Edit-Tools, die 
Selektionsanzeige, die Tracks-Liste und Scrolling-
Optionen.

Expanded Edit Tools
Bei aktivierter Expanded Edit Tools-Option 
werden alle relevanten Edit-Tools in der 
Symbolleiste des Score Editor-Fensters angezeigt. 

Wenn diese Option nicht aktiviert ist, wird nur das 
Symbol für das ausgewählte Edit-Tool angezeigt. 
Die anderen Edit-Tools können aus dem Edit-
Tool-Popup-Menü ausgewählt werden.

Selection Display
Bei aktivierter Option Selection Display wird die 
Edit-Selektions-Anzeige in der Symbolleiste des 
MIDI Editor-Fensters angezeigt.

Track List
Bei aktivierter Option Track List wird die Tracks-
Liste im Score Editor-Fenster angezeigt.

Scrolling
Im Scrolling-Untermenü können Sie die Scroll-
Optionen für das Score Editor-Fenster unabhängig 
vom Edit-Fenster und von den MIDI Editor-
Fenstern auswählen. Zu den Scroll-Optionen 
gehören:

Kein Scrollen – das Score Editor-Fenster wird 
weder während noch nach der Wiedergabe gescrollt. 
– der Playback-Cursor bewegt sich durch das Edit-
Fenster und zeigt die Wiedergabeposition an.

Nach Wiedergabe – der Playback-Cursor bewegt 
sich durch das Score Editor-Fenster und zeigt die 
Wiedergabeposition an. Wenn die Wiedergabe 
angehalten wird, scrollt das Score Editor-Fenster 
an die letzte Wiedergabeposition.

Page – der Playback-Cursor bewegt sich durch das 
Score Editor-Fenster und zeigt die 
Wiedergabeposition an. Wenn der rechte Rand der 
im Score Editor-Fenster aktuell angezeigten Seite 
erreicht ist, wird zur nächsten Seite geblättert und 
der Playback-Cursor bewegt sich weiter vom 
linken zum rechten Fensterrand.

Follow Edit Window – mit dieser Option folgt das 
Score Editor-Fenster der Scrolling-Option, die für 
das Edit-Fenster ausgewählt wurde (Options > Edit 

Window Scrolling).

Selektionsanzeige

Bei Pro Tools HD-Systemen stehen die 
Scrolling-Optionen „Continuous“ und 
„Center Playhead“ im Score Editor-Fenster 
nicht zur Verfügung. Wenn für das Score 
Editor-Fenster die Scrolling-Option „Follow 
Edit Window“ ausgewählt wird und für das 
Edit-Fenster entweder die Scrolling-Option 
„Continuous“ oder „Center Playhead“, 
wird im Score Editor-Fenster nach Seite 
gescrollt.



Kapitel 33: Score Editor 763

Anpassbare Symbolleiste
Sie können die Symbolleiste im Score Editor-
Fenster durch Neuanordnen sowie Ein- oder 
Ausblenden der verfügbaren Steuerelemente und 
Anzeigen ebenso wie im Edit-Fenster oder in den 
MIDI Editor-Fenstern anpassen.

Ändern der Anzeigeoptionen für 
die Symbolleiste

So ändern Sie die Anzeigeoptionen für die 
Symbolleiste im Score Editor-Fenster:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie im Score Editor-Fenster auf das 
Menü für die Symbolleiste.

• Klicken Sie mit der rechten Maustaste auf die 
Symbolleiste.

2 Aktivieren bzw. deaktivieren Sie im Popup-
Menü beliebige der folgenden Optionen:

• Selection Display

• Expanded Edit Tools

Neuanordnen von 
Steuerelementen und Anzeigen

So ordnen Sie Steuerelemente und Anzeigen einer 
Symbolleiste in einem MIDI Editor-Fenster neu an:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) oder Befehlstaste (Mac) auf die 
Steuerelemente bzw. Anzeigen, die Sie 
verschieben möchten, und ziehen Sie sie an eine 
neue Position in der Symbolleiste.

Spurenliste
Mit der Tracks-Liste können Sie MIDI- und 
Instrumentenspuren im Score Editor ein- und 
ausblenden. Darüber hinaus bietet Ihnen die Liste 
Zugriff auf die Dialogfelder „Notation Display 
Track Settings“ und „Score Setup“ (siehe 
„Notation Display Track Settings“ auf Seite 766 
und „Score Setup“ auf Seite 768).

So blenden Sie die Tracks-Liste im Score Editor-
Fenster ein oder aus:

 Aktivieren oder deaktivieren Sie im Score 
Editor-Fenstermenü die Option Track List.

Ein- und Ausblenden von Spuren
Mit der Tracks-Liste können Sie MIDI- und 
Instrumentenspuren als Notenzeilen in der Partitur 
ein- und ausblenden.

So blenden Sie MIDI- und Instrumentenspuren im 
Score Editor ein:

 Aktivieren Sie für die Spuren, die Sie in der 
Partitur anzeigen möchten, in der Tracks-Liste 
das Symbol zum Ein-/Ausblenden von Spuren.

Partial Score: Violine I und Violine II werden 
eingeblendet, alle anderen Spuren sind ausgeblendet



Pro Tools-Referenzhandbuch764

So blenden Sie alle MIDI- und Instrumentenspuren 
im Score Editor ein:

 Wählen Sie im Popup-Menü der Tracks-Liste 
Show All Tracks.

So blenden Sie nur ausgewählte MIDI- und 
Instrumentenspuren im Score Editor ein:

1 In der Tracks-Liste können Sie gewünschte 
MIDI- und Instrumentenspuren in der Partitur 
ein- und ausblenden.

2 Wählen Sie im Popup-Menü der Tracks-Liste 
Show Only Selected Tracks.

So blenden Sie MIDI- und Instrumentenspuren im 
Score Editor aus:

 Deaktivieren Sie für die Spuren, die Sie in der 
Partitur ausblenden möchten, in der Tracks-
Liste das Symbol zum Ein-/Ausblenden von 
Spuren.

So blenden Sie alle MIDI- und Instrumentenspuren 
im Score Editor aus:

 Wählen Sie im Popup-Menü der Tracks-Liste 
Hide All Tracks.

So blenden Sie ausgewählte MIDI- und 
Instrumentenspuren im Score Editor aus:

1 Wählen Sie in der Tracks-Liste die MIDI- und 
Instrumentenspuren aus, die Sie in der Partitur 
ausblenden möchten.

2 Wählen Sie im Popup-Menü der Tracks-Liste 
Hide Selected Tracks.

Seiten-Steuerelemente
Im Score Editor-Fenster stehen Steuerelemente zur 
Vorwärts- und Rückwärtsnavigation nach Seiten 
zur Verfügung. Die aktuelle Seitenzahl wird in der 
linken unteren Ecke des Fensters angezeigt.

So zeigen Sie die nächste Seite der Partitur an:

 Klicken Sie auf die Schaltfläche zum 
Weiterblättern.

So zeigen Sie die vorherige Seite der Partitur an:

 Klicken Sie auf die Schaltfläche zum 
Zurückblättern.

So zeigen Sie eine bestimmte Seite der Partitur an:

1 Klicken Sie auf die aktuelle Seitenanzeige.

2 Geben Sie die Seitenzahl der gewünschten 
Seite ein.

3 Drücken Sie die Eingabe-Taste (Windows) bzw. 
die Return-Taste (Mac).

Score Editor-Seiten-Steuerelemente

Weiterblättern

Zurückblättern

Anzeige der aktuellen Seite
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Score Editor-Zoom-
Steuerelemente
Zusätzlich zum Zoomer-Tool bietet der Score 
Editor Schaltflächen für das Heran- und 
Herauszoomen in der unteren rechten Ecke des 
Fensters. Darüber hinaus steht ein Zoom-Selektor 
zur Verfügung, mit dem um einen voreingestellten 
Prozentsatz oder auf eine bestimmte Seitengröße 
gezoomt werden kann. Wenn Sie die Zoom-
Steuerelemente verwenden, zoomt der Score 
Editor im Bereich der aktuellen Edit-Selektion.

So vergrößern Sie um eine Stufe:

 Klicken Sie auf die Zoom-In-Schaltfläche.

So verkleinern Sie um eine Stufe:

 Klicken Sie auf die Zoom-Out-Schaltfläche.

So zoomen Sie auf einen voreingestellten 
Prozentsatz:

1 Klicken Sie auf den Zoom-Selektor.

2 Wählen Sie im Zoom-Popup-Menü den Zoom-
Prozentsatz aus.

So zoomen Sie auf eine voreingestellte Seitengröße:

1 Klicken Sie auf den Zoom-Selektor.

2 Wählen Sie im Zoom-Popup-Menü die 
Seitengröße aus.

Zoomen auf Seitengrößen
Im Zoom-Popup-Menü stehen die folgenden 
Seitengrößen zur Verfügung.

Fit Page Width – es wird ein Zoom-Faktor 
gewählt, bei dem die Seite in ihrer Breite ins Score 
Editor-Fenster passt.

Fit Page Height – es wird ein Zoom-Faktor 
gewählt, bei dem die Seite in ihrer Höhe ins Score 
Editor-Fenster passt.

Fit Page – es wird ein Zoom-Faktor gewählt, bei 
dem die ganze Seite ins Score Editor-Fenster passt.

Fit 2 Pages – es wird ein Zoom-Faktor gewählt, 
bei dem zwei Seiten horizontal ins Score Editor-
Fenster passen.

Score Editor-Zoom-Steuerelemente

Zoom In
Zoom Out

Zoom-Selektor

Auswählen eines Zoom-Prozentsatzes aus dem 
Zoom-Popup-Menü
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Notation Display Track 
Settings
Im Dialogfeld „Notation Display Track Settings“ 
können Sie festlegen, wie einzelne MIDI- und 
Instrumentenspuren im Score Editor angezeigt 
werden. Sie können den Notenschlüssel und die 
Anzeigequantisierung einrichten und festlegen, 
ob die Spur bei „Kammertonhöhe“ oder als 
transponierendes Instrument (etwa Tenor-Saxofon 
in B) angezeigt wird.

So konfigurieren Sie die Einstellungen für 
„Notation Display Track Settings“:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie im Track-Menü des Score Editor 
Notation Display Track Settings.

• Klicken Sie mit der rechten Maustaste im Score 
Editor und wählen Sie Notation Display Track 

Settings.

• Doppelklicken Sie auf einen Notenschlüssel auf 
einer Notenzeile.

2 Wählen Sie aus dem Track-Popup-Menü die 
MIDI- oder Instrumentenspur, deren 
Einstellungen Sie ändern möchten.

3 Legen Sie die Einstellungen fest.

4 Wiederholen Sie diese Schritte nach Bedarf für 
andere MIDI- und Instrumentenspuren.

Optionen für „Notation Display 
Track Settings“

Track

Wählen Sie im Track-Popup-Menü die zu 
konfigurierende Spur aus.

Clef

Wählen Sie im Clef-Popup-Menü den 
Notenschlüssel aus, den Sie für die selektierte Spur 
verwenden möchten. Sie haben folgende 
Auswahlmöglichkeiten:

• Grand Staff (Akkolade)

• Treble Clef (Violinschlüssel)

• Bass Clef (Bassschlüssel)

• Alto Clef (Altschlüssel)

• Tenor Clef (Tenorschlüssel)

Display Transposition

Wählen Sie aus dem Popup-Menü „Key“ die 
Tonart für die Transposition der Spur. 
Bei Instrumenten, die aus einer anderen Oktave 
transponieren, können Sie auch den Oktaven-
Schieberegler entsprechend anpassen. Wählen 
Sie beispielsweise für eine Bassklarinettenspur 
die Tonart B und ziehen Sie den Oktaven-
Schieberegler auf +1. Auf diese Weise kann der 
Spieler, wenn Sie den Part für Bassklarinette 
drucken, den Part lesen und die Kammertonhöhe 
liegt korrekterweise eine große None unterhalb der 
Tonhöhe, in der der Part geschrieben wurde.

Spureinstellungen in der Notationsanzeige
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Attributes

Auf der Attributes-Registerkarte können Sie die 
Quantisierungseinstellungen für die 
Notationsanzeige der selektierten Spur angeben. 
Wenn unter Clef die Option Grand Staff 
ausgewählt wurde, können Sie auch die Split Point-
Einstellung festlegen, um Noten zwischen Violin- 
und Bassschlüsseln aufzuteilen.

Follow Globals

Wenn die Option Follow Globals aktiviert ist, 
verwenden die Spurattribute die globalen 
Attributeinstellungen (siehe „Globals“ auf 
Seite 767). Diese Option ist standardmäßig für alle 
Spuren aktiviert.

Display Quantization

Mit der Einstellung Display Quantization können 
Sie das Quantisierungsraster für die Anzeige von 
MIDI-Noten bei der Musiknotation auswählen. 
MIDI-Noten in Pro Tools behalten weiterhin ihre 
ursprüngliche Startzeit und Dauer bei. Diese 
Einstellung beeinflusst, welche Notenwerte 
angezeigt werden. Die Notationsanzeige wird auf 
den nächstgelegenen selektierten Notenwert 
quantisiert.

Straighten Swing

Bei aktivierter Option Straighten Swing werden in 
„Swing-Spielweise“ dargestellte Noten als nicht 
akzentuierte Noten dargestellt. Ein Lauf von 
Achtelnoten im Swing-Rhythmus wird also 
beispielsweise als normale Achtelnoten angezeigt.

Allow Note Overlap

Pro Tools zeigt immer nur eine rhythmische Linie 
auf einer einzelnen Notenzeile an. Wenn sich zwei 
Noten mit verschiedenen Startzeiten überlappen, 
wird die erste Note abgeschnitten, wenn die zweite 
Note beginnt. Wenn die Option Allow Note 

Overlap aktiviert ist, zeigt Pro Tools die volle 
Länge überlappender Noten mithilfe gebundener 
Noten an.

Split Point

Wenn als Schlüssel-Option für die selektierte Spur 
„Grand Staff“ ausgewählt wurde, bestimmt die 
gewählte Split Point-Einstellung, bei welcher 
Tonhöhe die Noten in der oberen oder unteren 
Notenzeile der Akkolade platziert werden.

Automatic – wenn diese Option aktiviert ist, teilt 
Pro Tools Noten zwischen der oberen und unteren 
Notenzeile der Akkolade basierend auf logischen 
Notengruppierungen.

Fixed – wenn diese Option aktiviert ist, können Sie 
eine bestimmte Tonhöhe festlegen, ab der Noten in 
der oberen bzw. unteren Notenzeile der Akkolade 
platziert werden.

Globals

Die Globals-Registerkarte enthält dieselben 
Einstellungen wie die Attributes-Registerkarte 
(siehe „Attributes“ auf Seite 767). Sie können auf 
der Attributes-Registerkarte für jede einzelne Spur 
festlegen, welche Spuren die Einstellungen auf der 
Globals-Registerkarte befolgen.

Fenster „Notation Display Track Settings“, Attributes-
Registerkarte



Pro Tools-Referenzhandbuch768

Score Setup
Im Score Setup-Fenster können Sie das Seitenlayout 
und die Abstände zwischen Notenzeilen einstellen. 
Sie können hier außerdem Titel und Komponist der 
Partitur eingeben. Darüber hinaus können Sie 
auswählen, welche Partiturelemente angezeigt 
werden sollen. Änderungen im Score Setup-Fenster 
werden sofort in den Score Editor übernommen.

Sie haben folgende Möglichkeiten, das Score 
Setup-Fenster zu öffnen:

 Wählen Sie File > Score Setup.

 Wählen Sie im Track-Menü des Score Editor-
Fensters die Option Score Setup.

 Klicken Sie mit der rechten Maustaste im Score 
Editor-Fenster und wählen Sie die Option Score 

Setup.

Optionen im Score Setup-
Fenster

Information

Titel – hier können Sie den Titel der Partitur 
eingeben. Dieser wird oben auf der ersten Seite 
angezeigt.

Composer – hier können Sie den Komponisten der 
Partitur eingeben. Der Name wird oben auf der 
ersten Seite in der oberen rechten Ecke angezeigt.

Anzeige

Die Optionen unter „Display“ bestimmen, welche 
Elemente in der Partitur angezeigt werden. 
Deaktivieren Sie die Elemente, die nicht in der 
Partitur angezeigt werden sollen.

Score Setup (Fenster)
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Title and Composer – wählen Sie diese Option 
aus, um Titel und Komponist der Partitur 
anzuzeigen.

Page Numbers – aktivieren Sie diese Option, 
um die Seitenzahlen am Ende jeder Seite 
anzuzeigen.

Bar Numbers – aktivieren Sie diese Option, 
um die Taktzahlen am Anfang jedes Notensystems 
über der obersten Notenzeile anzuzeigen.

Track Names – bei dieser Option werden die 
Spurnamen für jede Notenzeile am Beginn der 
Partitur angezeigt.

Akkordsymbole – aktivieren Sie diese Option, 
um in der Partitur Akkordsymbole anzuzeigen.

Chord Diagrams – aktivieren Sie diese Option, 
um in der Partitur Akkorddiagramme 
(Gitarrentabulatur) anzuzeigen (siehe 
„Akkordsymbole und -diagramme“ auf Seite 775).

Spacing

Between Staves – geben Sie ein, in welchem 
Abstand die Notenzeilen zueinander stehen sollen.

Between Systems – geben Sie ein, in welchem 
Abstand die Notensysteme zueinander stehen 
sollen.

Below Title and Composer – geben Sie den 
Abstand zwischen den Angaben zu Titel und 
Komponisten und der ersten Notenzeile der 
Partitur ein.

Below Chord Symbols and Diagrams – geben Sie 
den Abstand zwischen den Angaben zu 
Akkordsymbolen und -diagrammen und der 
obersten Notenzeile jedes Systems ein.

Layout

Page Size – wählen Sie das Papierformat: Letter, 
Legal, Tabloid oder A4.

Portrait – hiermit wird die Seite im Hochformat 
ausgerichtet.

Landscape – hiermit wird die Seite im Querformat 
ausgerichtet.

Staff Size – geben Sie die Größe der Notenzeilen ein.

Page Margins – geben Sie hier die Abmessungen für 
die Seitenränder oben, unten, links und rechts ein. 

Inches – wählen Sie diese Option aus, 
um Abmessungen in Zoll einzugeben.

Millimeters – wählen Sie diese Option aus, 
um Abmessungen in Millimetern einzugeben.

Editieren von Noten
Das Editieren von MIDI-Noten im Edit-Fenster, 
in den MIDI Editor-Fenstern und im Score Editor-
Fenster hat stets denselben Einfluss auf die MIDI-
Daten. Wenn Sie einen Editiervorgang in einem 
Fenster ausführen, werden die Auswirkungen in 
allen anderen Fenstern widergespiegelt. 

Der Score Editor enthält einfache Partitur-Edit-
Tools zum Eingeben, Verschieben und 
Transponieren von MIDI-Noten in Form von 
Notenschrift: 

• Mit dem Trim-Tool können Sie die Dauer einer 
Note verlängern oder verkürzen.

• Mit dem Note Selector-Tool können Sie Noten 
in der Partitur selektieren.

Deaktivieren Sie die Chord Diagrams-
Option, wenn Sie Diagramme und Leadsheets 
drucken, bei denen Sie nur die 
Akkordsymbole sehen möchten.

Auf Seiten, auf denen die Musik vertikal 
ausgerichtet ist, sind die Abstände zwischen 
Notenzeilen und Systemen größer als die 
angegebenen Zahlen.
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• Mit dem Grabber-Tool können Sie Noten 
selektieren und an andere Zeitpositionen oder 
auf andere Tonhöhen in derselben Spur ziehen. 

• Mit dem Pencil-Tool können Sie Noten einfügen 
und sie an andere Zeitpositionen oder auf andere 
Tonhöhen in derselben Spur ziehen.

Selektieren von Noten
Sie können entweder das Note Selector-Tool oder 
das Grabber-Tool verwenden, um Noten auf einer 
oder mehreren Notenzeilen zu selektieren.

So selektieren Sie Noten auf einer oder mehreren 
Notenzeilen mit dem Note Selector-Tool:

1 Klicken Sie auf das Note Selector-Tool.

2 Ziehen Sie in der Partitur, um die gewünschten 
Noten zu markieren.

So ziehen Sie mit dem Grabber-Tool einen Rahmen 
um eine oder mehrere Notenzeilen:

1 Klicken Sie auf das Grabber-Tool.

2 Ziehen Sie in der Partitur, um die gewünschten 
Noten zu markieren.

Transponieren von Noten
Sie können mit dem Grabber- oder dem Pencil-
Tool Noten auch manuell um eine Note nach oben 
oder unten transponieren. Darüber hinaus können 
Sie auch mithilfe des Event-Vorgangs 
„Transpose“ (Event > Event Operations > 

Transpose) selektierte Noten transponieren.

So transponieren Sie eine einzelne Note:

1 Klicken Sie auf das Grabber-Tool.

2 Ziehen Sie die Note, die Sie transponieren 
möchten, nach oben oder unten.

So transponieren Sie alle selektierten Noten:

1 Klicken Sie auf das Grabber-Tool.

2 Ziehen Sie einen Bereich um die Noten, die Sie 
transponieren möchten, um diese zu selektieren.

3 Ziehen Sie die selektierten Noten nach oben 
oder unten, um sie zu transponieren.

Selektieren von Noten mit dem Note Selector-Tool

Selektieren von Noten mit dem Grabber-Tool

Transponieren einer Note mit dem Grabber-Tool

Transponieren selektierter Noten mit dem Grabber-
Tool
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Verschieben von Noten
Verwenden Sie das Grabber-Tool, um selektierte 
Noten von einer Zeitposition zu einer anderen auf 
derselben Notenzeile zu verschieben. Wenn Sie 
Noten im Score Editor verschieben, behalten die 
zugrundeliegenden MIDI-Noten ihre Position 
relativ zum Raster bei.

So verschieben Sie Noten an eine andere 
Zeitposition:

1 Klicken Sie auf das Grabber-Tool.

2 Wenn Sie mehrere Noten verschieben möchten, 
selektieren Sie die gewünschten Noten, indem 
Sie einen Bereich darum ziehen.

3 Ziehen Sie die selektierten Noten an eine andere 
Zeitposition auf derselben Notenzeile.

Einfügen von Noten
Verwenden Sie das Pencil-Tool, um manuell 
Noten im Score Editor einzufügen. Wenn Sie eine 
Note einfügen, platziert der Score Editor sie 
automatisch auf dem Raster und erstellt 
gegebenenfalls Pausen.

So fügen Sie eine Note manuell ein:

1 Wählen Sie den Wert für „Default Note 
Duration“ (siehe „Default Note Duration“ auf 
Seite 759).

2 Wählen Sie den Grid-Wert aus (siehe „Raster“ 
auf Seite 761).

3 Wählen Sie den gewünschten Wert für „Default 
Note On Velocity“ (siehe „Default Note On 
Velocity“ auf Seite 759).

4 Klicken Sie auf das Pencil-Tool und wählen Sie 
„Free Hand“.

5 Führen Sie mit dem Pencil-Tool Free Hand 
einen der folgenden Schritte aus:

• Klicken Sie einmal auf die Zeitposition und 
Tonhöhe, auf der sie eine einzelne Note der 
ausgewählten Standardnotendauer eingeben 
möchten.

Verschieben selektierter Noten mit dem Grabber-Tool

Sie können Noten im Score Editor auch mit der 
Nudge-Funktion entsprechend dem aktuell 
ausgewählten Rasterwert (Grid Value) 
bewegen.

Sie können Noten auch durch Aufnahme von 
MIDI, Importieren von MIDI aus einer Datei 
oder über „Step Input“ (Event > Event 
Operations > Step Input) eingeben.

Eingeben einer einzelnen Note mit dem Pencil-Tool



Pro Tools-Referenzhandbuch772

• Klicken Sie auf die Zeitposition und Tonhöhe 
und ziehen Sie die Maus nach rechts, um die 
Notendauer zu erhöhen.

So fügen Sie manuell mehrere Noten auf 
derselben Tonhöhe ein:

1 Wählen Sie den Wert für „Default Note 
Duration“ (siehe „Default Note Duration“ auf 
Seite 759).

2 Wählen Sie den Grid-Wert aus (siehe „Raster“ 
auf Seite 761).

3 Wählen Sie den gewünschten Wert für „Default 
Note On Velocity“ (siehe „Default Note On 
Velocity“ auf Seite 759).

4 Klicken Sie auf das Pencil-Tool und wählen Sie 
eine der folgenden Formen aus:

• Zeile

• Triangle

• Square

• Random

5 Klicken Sie auf die Zeitposition und Tonhöhe 
und ziehen Sie die Maus nach rechts. Es werden 
wiederholte Noten der ausgewählten 
Standardnotendauer im ausgewählten Raster 
eingefügt. Die Note On Velocity-Werte für die 
einzelnen Note werden teilweise durch die 
Einstellung für „Default Note On Velocity“ und 
durch die ausgewählte Form des Pencil-Tools 
bestimmt (siehe „Pencil“ auf Seite 758).

Pausen
Der Score Editor fügt Pausen automatisch nach 
Bedarf hinzu. Pausen können nicht manuell 
verschoben oder eingefügt werden.

Kontextmenü im Score Editor
Im Kontextmenü des Score Editor stehen 
verschiedene hilfreiche Befehle zum Bearbeiten, 
Exportieren und Formatieren von Partitur- und 
MIDI-Daten zur Verfügung.

So rufen Sie das Kontextmenü im Score Editor auf:

 Klicken Sie mit der rechten Maustaste auf eine 
beliebige Stelle in der Partitur.

Kontextmenüelemente im Score 
Editor

Tools

Im Tools-Untermenü können Sie sämtliche für den 
Score-Editor relevanten Edit-Tools aktivieren.

Zoomer – aktiviert das Zoomer-Tool.

Note Selector – aktiviert das Note Selector-Tool.

Grabber – aktiviert das Grabber-Tool.

Stift – aktiviert das Pencil-Tool.

Eingeben einer einzelnen längeren Note mit dem 
Pencil-Tool

Einfügen mehrerer Noten auf derselben Tonhöhe mit 
dem Pencil-Tool Line
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Insert

Über das Insert-Untermenü können Sie Tonart- 
und Taktartänderungen sowie Akkordsymbole an 
der jeweiligen Position des Edit-Cursors in die 
Partitur einfügen.

Key – fügt einen Tonartwechsel ein.

Pegelanzeige – fügt einen Taktartwechsel ein.

Akkord – fügt ein Akkordsymbol ein.

Ausschneiden

Mit dem Cut-Befehl wird die aktuelle Edit-
Selektion ausgeschnitten.

Copy

Mit dem Copy-Befehl wird die aktuelle Edit-
Selektion kopiert.

Paste

Mit dem Paste-Befehl wird der Inhalt der 
Zwischenablage in die aktuelle Edit-Selektion 
oder an der aktuellen Position des Edit-Cursors 
eingefügt. Sämtliche bereits zuvor an der Position 
vorhandenen MIDI-Noten werden überschrieben.

Zusammenführen

Mit dem Merge-Befehl wird der Inhalt der 
Zwischenablage in die aktuelle Edit-Selektion 
oder an der aktuellen Position des Edit-Cursors 
eingefügt. Die eingefügten Daten werden mit 
bereits an derselben Position vorhandenen MIDI-
Noten zusammengeführt.

Clear

Mit dem Clear-Befehl wird die aktuelle Edit-
Selektion gelöscht.

Event-Vorgänge

Im Untermenü „Event Operations“ können Sie die 
verschiedenen Event Operations-Fenster (etwa 
„Quantize“ oder „Change Velocity“) auswählen.

In MIDI-Editor öffnen

Die Open in MIDI Editor-Option öffnet die im 
Score Editor angezeigten Spuren in einem MIDI 
Editor-Fenster.

In MIDI-Event-Liste öffnen

Mit der Option Open In MIDI Event List wird die 
ausgewählte Spur in der MIDI Event-Liste 
geöffnet.

Spureinstellungen in der Notationsanzeige

Mit der Notation Display Track Settings-Option 
wird das gleichnamige Dialogfeld geöffnet (siehe 
„Notation Display Track Settings“ auf Seite 766).

Notationseinstellungen

Mit der Score Setup-Option wird das 
gleichnamige Dialogfeld geöffnet (siehe „Score 
Setup“ auf Seite 768).

An Sibelius senden

Mit der Send to Sibelius-Option wird die Partitur 
genauso, wie sie im Score Editor-Fenster 
dargestellt wird, an die Notations-Software 
Sibelius gesendet (siehe „Exportieren von 
Partituren“ auf Seite 776).

Partitur drucken

Mit dem Print Score-Befehl wird die Partitur 
gedruckt (siehe „Drucken von Partituren“ auf 
Seite 777).
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Tonartänderungen
Sie können in Ihrer Partitur Generalvorzeichen 
hinzufügen, bearbeiten und löschen. 
Generalvorzeichen wirken sich auf die 
Schreibweise von MIDI-Noten in der Partitur aus. 
Beispielsweise ist die MIDI-Note 58 (B3) ein b in 
F-Dur, aber ein ais in H-Dur.

So führen Sie ein Generalvorzeichen hinzu:

1 Verwenden Sie das Note Selector-, Grabber- oder 
Pencil-Tool und klicken Sie mit der rechten 
Maustaste auf die Position in der Partitur, an der 
Sie einen Tonartwechsel vornehmen möchten. 
Wählen Sie dann Insert > Key Change.

2 Wählen Sie im Key Change-Dialogfeld das 
Tongeschlecht (Dur oder Moll), die Tonart, 
die Position und den Bereich und wie Spuren 
bestimmter Tonhöhen davon beeinflusst werden 
sollen.

3 Klicken Sie auf OK.

Das ausgewählte Generalvorzeichen wird in der 
Partitur angezeigt und die Schreibweisen für 
Noten nach dem Tonartwechsel werden 
entsprechend aktualisiert.

So bearbeiten Sie ein Generalvorzeichen:

1 Doppelklicken Sie mit dem Grabber-Tool auf 
das Generalvorzeichen, das Sie bearbeiten 
möchten.

2 Geben Sie Werte in das Key Change-Dialogfeld 
ein und klicken Sie auf OK.

So löschen Sie ein Generalvorzeichen:

 Wählen Sie das Grabber-Tool und klicken Sie 
bei gedrückter Alt-Taste (Windows) oder 
Wahltaste (Mac) auf das zu löschende 
Generalvorzeichen.

Taktartänderungen
Sie können in Ihrer Partitur Taktarten hinzufügen, 
bearbeiten und löschen. Änderungen an der Taktart 
beeinflussen die Anzahl der Takte in der Partitur 
(und in Ihrer Session). Wenn Sie die Taktart ändern, 
werden die Noten nicht verschoben, aber die 
Taktstriche werden neu angeordnet.

So fügen Sie eine Taktartänderung hinzu:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Event > Time Operations > Change 
Meter.

• Verwenden Sie das Note Selector-, Grabber- 
oder Pencil-Tool und klicken Sie mit der rechten 
Maustaste auf die Position in der Partitur, an der 
Sie einen Taktartwechsel vornehmen möchten. 
Wählen Sie dann Insert > Meter Change.

2 Geben Sie im Meter Change-Dialogfeld Position 
und Taktart für die Taktartänderung ein.

3 Wenn Sie das eingefügte Taktart-Event genau 
auf dem ersten Schlag des nächstgelegenen 
Takts positionieren möchten, wählen Sie Snap 

To Bar.

Sie können auch Generalvorzeichen im 
Generalvorzeichen-Lineal des Edit-Fensters 
oder in einem beliebigen MIDI Editor-
Fenster hinzufügen und löschen.

Sie können auch Taktarten im Meter-Lineal 
des Edit-Fensters oder in MIDI Editor-
Fenstern hinzufügen und löschen.

Meter Change-Dialogfeld
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4 Wählen Sie einen Notenwert für die Anzahl der 
Metronom-Klicks pro Takt. Wenn Sie 
punktierte Notenwerte benötigen, wählen Sie 
das Punktsymbol (.) zusätzlich zum Notenwert.

5 Klicken Sie auf OK, um die neue Taktart 
einzufügen.

So bearbeiten Sie eine Taktartänderung:

1 Doppelklicken Sie mit dem Grabber-Tool auf 
das Taktart-Event, das Sie bearbeiten möchten.

2 Geben Sie Werte in das Meter Change-
Dialogfeld ein und klicken Sie auf OK.

So löschen Sie eine Taktartänderung:

 Wählen Sie das Grabber-Tool und klicken Sie 
bei gedrückter Alt-Taste (Windows) oder 
Wahltaste (Mac) auf das zu löschende Taktart-
Event.

Akkordsymbole und 
-diagramme
Sie können in Ihrer Partitur Akkordsymbole und 
-diagramme (Gitarrentabulatur) hinzufügen, 
bearbeiten und löschen. Akkordsymbole haben 
keine Auswirkungen auf MIDI-Daten. 
Außerdem werden Akkordsymbole beim 
Exportieren von MIDI-Daten aus Pro Tools in 
eine MIDI-Datei nicht berücksichtigt. Beim 
Export in eine Sibelius-Datei (.sib) hingegen 
oder beim Verwenden des Befehls Send to 

Sibelius werden Akkordsymbole berücksichtigt.

So fügen Sie ein Akkordsymbol ein:

1 Verwenden Sie das Note Selector-, Grabber- 
oder Pencil-Tool und klicken Sie mit der 
rechten Maustaste auf die Position in der 
Partitur, an der Sie ein Akkordsymbol 
hinzufügen möchten. Wählen Sie dann Insert > 

Chord.

2 Wählen Sie im Chord Change-Dialogfeld den 
Grundton des Akkords aus dem Chord-Selektor 
(etwa „D“)

3 Wählen Sie mit dem Chord Quality-Selektor 
das Geschlecht (etwa Dur oder Moll).

Bei einigen Taktarten kann es von Vorteil 
sein, punktierte Notenwerte als 
Metronomwert zu verwenden. Beispielsweise 
ist bei einem 6/8-Takt eine punktierte 
Viertelnote (also zwei Klicks pro Takt als 
Metronomwert) in der Regel geeigneter als 
eine Achtelnote (sechs Klicks pro Takt).

Sie können auch Akkordsymbole im Chord 
Symbol-Lineal des Edit-Fensters oder in MIDI 
Editor-Fenstern hinzufügen und löschen. 
Akkorddiagramme (Gitarrentabulatur) 
werden allerdings nur im Score Editor-
Fenster angezeigt.

Chord Change-Dialogfeld

Chord-Selektor

Chord Quality-
Selektor

Bass-
Selektor

Chord Diagrams
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4 Wählen Sie mit dem Bass-Selektor die 
Bassnote des Akkords (etwa B für einen 
umgekehrten G-Moll-Akkord) aus.

5 Wählen Sie ein Akkorddiagramm 
(Gitarrentabulatur) aus den verfügbaren 
Optionen aus.

6 Klicken Sie auf OK.

Das ausgewählte Akkordsymbol wird über der 
ersten Notenzeile des Notensystems angezeigt.

So bearbeiten Sie ein Akkordsymbol:

1 Doppelklicken Sie mit dem Grabber-Tool auf 
das Akkordsymbol, das Sie bearbeiten 
möchten.

2 Nehmen Sie im Chord Change-Dialogfeld 
Änderungen vor und klicken Sie auf OK.

So verschieben Sie ein Akkordsymbol:

 Ziehen Sie mit dem Grabber-Tool das 
Akkordsymbol an die neue Position.

So löschen Sie ein Akkordsymbol:

 Wählen Sie das Grabber-Tool und klicken Sie 
bei gedrückter Alt-Taste (Windows) oder 
Wahltaste (Mac) auf das zu löschende 
Akkordsymbol.

So blenden Sie Akkordsymbole in der Partitur ein 
oder aus:

 Aktivieren oder deaktivieren Sie im Score 
Settings-Dialogfeld (File > Score Setup) die 
Option Chord Symbols.

So blenden Sie Akkorddiagramme 
(Gitarrentabulatur) in der Partitur ein oder aus:

 Aktivieren oder deaktivieren Sie im Score 
Settings-Dialogfeld (File > Score Setup) die 
Option Chord Diagrams.

Exportieren von Partituren
Mit Pro Tools können Sie die Partitur aus Ihrer 
Session als Sibelius-Datei (.sib) exportieren. 
Sie können Ihre durch Pro Tools transkribierte 
Partitur in Sibelius öffnen, den Notensatz 
bearbeiten und die Partitur sowie einzelne Parts 
mit Sibelius drucken.

So exportieren Sie eine Partitur aus Pro Tools:

1 Konfigurieren Sie die Partitur für Ihre Session 
im Score Editor-Fenster.

2 Wählen Sie File > Export > To Sibelius.

3 Wählen Sie ein Ziel und klicken Sie auf Save.

Um die Partitur aus Ihrer Pro Tools-Session an 
Sibelius zu senden, führen Sie einen der 
folgenden Schritte aus:

1 Konfigurieren Sie die Partitur für Ihre Session 
im Score Editor-Fenster.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie File > Send to Sibelius.

• Klicken Sie mit der rechten Maustaste im Score 
Editor und wählen Sie Send to Sibelius.

Akkordsymbol und -diagramm in der Partitur Zum Öffnen von aus Pro Tools exportierten 
SIB-Dateien ist Sibelius 5.x oder höher 
erforderlich.
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Pro Tools exportiert alle Instrumenten- und MIDI-
Spuren, die im Score Editor angezeigt werden, 
als SIB-Datei in Sibelius. Falls Sibelius auf dem 
Computer installiert ist, wird es gestartet. Sie 
können dann den Notensatz weiter in Sibelius 
bearbeiten und eine Partitur oder einzelne Parts 
drucken.

Drucken von Partituren
Pro Tools bietet Ihnen die Möglichkeit, die 
Partitur Ihrer Pro Tools-Session zu drucken. Die 
Partitur wird genauso gedruckt, wie sie im Score 
Editor-Fenster angezeigt wird. Konfigurieren Sie 
das Partitur-Setup und blenden Sie MIDI- und 
Instrumentenspuren ein oder aus. Nur die 
eingeblendeten Spuren werden gedruckt.

So drucken Sie die Partitur Ihrer Pro Tools-
Session:

1 Öffnen Sie das Score Editor-Fenster und 
konfigurieren Sie Ihre Partitur.

2 Wählen Sie File > Print Score.

3 Nehmen Sie im Druckdialogfeld die 
gewünschten Einstellungen vor und klicken Sie 
auf OK (Windows) bzw. Drucken (Mac).

Drücken Sie Strg + P (Windows) bzw. 
Befehl + P (Mac), um die Partitur zu drucken.
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Kapitel 34: MIDI Event-Liste

In der MIDI Event-Liste wird eine genaue 
Auflistung aller Events einer MIDI- oder 
Instrumentenspur angezeigt. Die Events werden 
mit Text und Nummern dargestellt, sodass Sie 
deren Position, Dauer und spezifische Werte 
präzise bearbeiten können.

Events in der MIDI Event-Liste können kopiert 
und eingefügt, selektiert und gelöscht werden. 
Alle MIDI-Events (außer Sysex-Daten) können 
in die Liste eingefügt und dort bearbeitet werden. 
Bestimmte Arten von MIDI-Events können mit 
dem Ansichtsfilter (View Filter) ausgeblendet 
werden.

Öffnen der MIDI Event-Liste
Sie haben folgende Möglichkeiten, die MIDI Event-
Liste zu öffnen:

 Wählen Sie Windows > MIDI Event List.

 Klicken Sie im Mix- oder Edit-Fenster oder in 
der Tracks-Liste mit der rechten Maustaste auf 
den Namen einer MIDI- oder Instrumentenspur.

Track-Selektor
Der Track-Selektor in der MIDI Event-Liste gibt 
die aktuell angezeigte MIDI- oder 
Instrumentenspur an und kann dazu verwendet 
werden, eine andere MIDI- oder Instrumentenspur 
für die Anzeige zu wählen.

MIDI Event List

Anzahl der Events Menü der MIDI Event-Liste

Track-Selektor Target (Ziel)

Im Gegensatz zu den Playlists im Edit-
Fenster kann polyphoner Aftertouch in die 
MIDI Event-Liste eingefügt und dort 
angezeigt werden.

Stummgeschaltete Daten auf MIDI- und 
Instrumentenspuren werden in der MIDI 
Event-Liste nicht angezeigt.

Drücken Sie Alt + Gleichheitszeichen 
(Windows) bzw. Wahl + Gleichheitszeichen 
(Mac), um die MIDI Event-Liste zu öffnen.
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Anzahl der Events
Die Anzahl der MIDI-Events auf der selektierten 
Spur wird ganz oben in der MIDI Event-Liste 
angegeben.

Target (Ziel)
Über die Target-Schaltfläche für die MIDI Event-
Liste wird festgelegt, ob diese dasselbe abbildet 
wie der Edit-Cursor und die Edit-Selektionen im 
Edit-Fenster bzw. im MIDI Editor-Fenster. Wenn 
die Target-Schaltfläche aktiviert ist, werden 
beispielsweise die in der MIDI Event-Liste 
angezeigten Events so aktualisiert, dass sie das 
Event in der Edit-Selektion im Edit-Fenster 
anzeigen. Ist die Target-Schaltfläche hingegen 
deaktiviert, zeigt die MIDI Event-Liste immer 
dieselben Events an, unabhängig von Änderungen, 
die in anderen Fenstern an der Edit-Selektion 
vorgenommen werden.

Menü der MIDI Event-Liste
Das Menü der MIDI Event-Liste enthält Befehle 
und Optionen für die MIDI Event-Liste (siehe 
„Optionen für die MIDI Event-Liste“ auf 
Seite 787). 

Spalten in der MIDI Event-Liste
Die Informationen zu den in der MIDI Event-Liste 
aufgeführten Events werden in den folgenden drei 
Spalten angezeigt:

Start. – zeigt die Startposition eines jeden Events 
unter Verwendung der Haupt-Zeitskala an. 
Positionen können auch in der Sub-Zeitskala 
angezeigt werden, wenn die Show Sub Counter-
Option im Options-Popup-Menü aktiviert ist.

Der Playback-Cursor erscheint in der Start-Spalte 
als blauer Pfeil (rot, wenn die Spur 
scharfgeschaltet ist).

Wenn sich verschiedene Events auf derselben 
Position befinden, wird nur die Position des 
obersten Events in der Liste angezeigt, während 
die anderen abgeblendet sind. Die abgeblendeten 
Positionen können durch Doppelklicken bearbeitet 
werden.

Event. – zeigt den Event-Typ (durch ein Symbol) 
sowie dessen spezifische Werte an.

Length/Info. – zeigt den Endpunkt oder die Länge 
der Noten an, abhängig von der im Options-
Popup-Menü ausgewählten Option. Außerdem 
werden die Bezeichnungen der Continuous 
Controller-Events und Program Changes 
angezeigt.

Ansichtsfilter für die MIDI Event-
Liste
Sie können den Ansichtsfilter (View Filter) 
verwenden, um festzulegen, welche Event-Typen 
in der MIDI Event-Liste angezeigt werden sollen. 
Dies kann hilfreich sein, um sich nur auf die 
Events zu konzentrieren, die Sie bearbeiten 
möchten. Außerdem werden MIDI-Events so 
vor einer Löschung bzw. einer versehentlichen 
Änderung geschützt. Auch Events, die nicht in 
der MIDI Event-Liste erscheinen, werden 
wiedergegeben.

Spalten in der MIDI Event-Liste

 

Wiedergabe-
Cursor

Doppelklicken 
zum Editieren

gleichzeitiger
MIDI-Events
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Der Ansichtsfilter kann so eingestellt werden, dass 
entweder alle Befehle (All), nur die angegebenen 
Befehle (Only) oder alle außer den angegebenen 
Befehle (All Except) angezeigt werden.

Beispiel: So filtern Sie die Anzeige von Aftertouch 
und System Exclusive-Befehlen aus der MIDI 
Event-Liste:

1 Wählen Sie im Menü der MIDI Event-Liste die 
Option View Filter.

2 Wählen Sie im MIDI Event List View Filter-
Dialogfeld die All Except-Option.

3 Aktivieren Sie die Optionen für Mono 

Aftertouch, Polyphonic Aftertouch und System 

Exclusive. Lassen Sie alle anderen Befehle 
deaktiviert.

Bei Verwendung der All Except-Option werden die 
ausgewählten Events nicht angezeigt. Umgekehrt 
werden bei Verwendung der Only-Option nur die 
ausgewählten Events angezeigt.

4 Klicken Sie auf OK.

Navigieren in der MIDI Event-
Liste
Mithilfe der Tab- und Pfeiltasten können Sie durch 
die MIDI Event-Liste navigieren. Sie können auch 
an den Edit-Startpunkt oder jede andere 
angegebene Position gehen.

Sie haben folgende Möglichkeiten, um in der MIDI 
Event-Liste zu navigieren:

• Doppelklicken Sie, um einen Wert zu bearbeiten.

• Drücken Sie die Tab-Taste oder die Pfeiltaste nach 
unten, um zum nächsten Event zu wechseln 
(unabhängig davon, ob das Edit-Feld aktiviert ist).

• Drücken Sie Strg + Tab (Windows) bzw. Wahl + 
Tab (Mac) oder die Nach-oben-Pfeiltaste, um 
zum vorherigen Event zu wechseln (unabhängig 
davon, ob das Edit-Feld aktiviert ist).

• Wenn Sie ein Edit-Feld aktiviert haben, können 
Sie durch Drücken der Nach-rechts-Pfeiltaste 
zum nächsten Edit-Feld rechts wechseln.

• Wenn Sie ein Edit-Feld aktiviert haben, können 
Sie durch Drücken der Nach-links-Pfeiltaste 
zum nächsten Edit-Feld links wechseln.

Um das letzte Event aktiviert zu lassen, halten Sie 
die Umschalttaste gedrückt, während Sie zum 
nächsten oder vorherigen Event wechseln.

So gehen Sie zum Edit-Startpunkt:

 Wählen Sie im Menü der MIDI Event-Liste die 
Option Scroll To Edit Selection.

Wenn Sie einen Event-Typ einfügen, der aus 
der MIDI Event-Liste ausgefiltert wurde, 
wird der Filter für diesen Event-Typ 
deaktiviert.

Drücken Sie, während sich die MIDI Event-
Liste im Vordergrund befindet, Strg + F 
(Windows) bzw. Befehl + F (Mac), um das 
Dialogfeld „MIDI Event List View Filter“ zu 
öffnen.

Dialogfeld „MIDI Event List View Filter“
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So gehen Sie zu einer bestimmten Position in der 
MIDI Event-Liste:

1 Wählen Sie im Menü der MIDI Event-Liste die 
Option Go To.

2 Wählen Sie im Go To-Dialogfeld ein Format 
aus dem Time Scale-Popup-Menü.

3 Wenn Sie Timecode verwenden, können Sie die 
Option Use Subframes aktivieren.

4 Geben Sie die Position ein, zu der Sie wechseln 
möchten, und klicken Sie auf OK.

Folgende Optionen aus dem Menü der MIDI 
Event-Liste beeinflussen die Navigation in der 
MIDI Event-Liste:

• Wenn die Option Page Scroll During Playback 
aktiviert ist, wird die MIDI Event-Liste während 
der Wiedergabe gescrollt.

• Wenn Scroll During Edit Selection aktiviert ist, 
wird die MIDI Event-Liste automatisch 
gescrollt, wenn die Edit-Selektion im Edit-
Fenster geändert wird.

Einfügen von Events in die 
MIDI Event-Liste
Sie können Events in die MIDI Event-Liste 
einfügen, indem Sie einen Event-Typ aus dem 
Menü der MIDI Event-Liste wählen. Im Folgenden 
werden verschiedene Beispiele für das Einfügen 
von Events in die MIDI Event-Liste aufgeführt.

So fügen Sie eine Note in die MIDI Event-Liste ein:

1 Wählen Sie im Menü der MIDI Event-Liste die 
Option Insert > Note.

2 Geben Sie Position, Tonhöhe, Attack- 
und Release-Velocity („Note On“ bzw. 
„Note Off“) sowie die Dauer der neuen Note 
ein. Um zwischen den Event-Eingabefeldern zu 
wechseln, verwenden Sie die Pfeiltasten nach 
links und rechts. 

Bei einem aktivierten Feld haben Sie folgende 
Möglichkeiten, einen Wert einzugeben:

• Geben Sie den Wert über den Ziffernblock ein.

• Ziehen Sie nach oben oder unten, um zum 
gewünschten Wert zu gelangen.

Drücken Sie, während sich die MIDI Event-
Liste im Vordergrund befindet, Strg + G 
(Windows) bzw. Befehl + G (Mac), um das Go 
To-Dialogfeld zu öffnen.

Go To-Dialogfeld

Drücken Sie, während sich die MIDI Event-
Liste im Vordergrund befindet, Strg + N 
(Windows) bzw. Befehl + N (Mac), um eine 
Note einzufügen.

Event-Eingabefelder für Noten

Pitch

Attack-Velocity

Release-Velocity
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• Spielen Sie die Note auf Ihrem MIDI-Controller-
Keyboard und drücken Sie anschließend zum 
Bestätigen des Werts auf der Tastatur die 
Eingabetaste (Windows) bzw. die Return-
Taste (Mac).

3 Sie haben folgende Möglichkeiten:

• Um eine Note einzufügen und weiter in den 
Event-Eingabefeldern zu arbeiten, drücken Sie 
die Enter-Taste auf dem Ziffernblock.

• Um eine Note einzufügen und die Event-
Eingabefelder zu verlassen, drücken Sie die 
Eingabetaste (Windows) bzw. die Return-Taste 
(Mac) auf der Tastatur.

• Um die Event-Eingabefelder zu verlassen, ohne 
eine neue Note einzufügen, drücken Sie die Esc-
Taste auf der Tastatur.

So fügen Sie ein Controller-Event in die MIDI 
Event-Liste ein:

1 Wählen Sie im Menü der MIDI Event-Liste die 
Option Insert > Controller.

2 Geben Sie die Position, den Controller-Typ und 
den Controller-Wert für das neue Event ein. Der 
Name des Controllers wird in der Length/Info-
Spalte rechts neben dem Controller-Wert 
angezeigt. Um zwischen den Event-
Eingabefeldern zu wechseln, verwenden Sie die 
Pfeiltasten nach links und rechts.

Bei einem aktivierten Feld haben Sie folgende 
Möglichkeiten, einen Wert einzugeben:

• Geben Sie den Wert über den Ziffernblock ein.

• Drücken Sie die Nach-oben- oder Nach-unten-
Pfeiltaste, um zum gewünschten Wert zu 
gelangen.

• Halten Sie die Strg-Taste (Windows) bzw. 
die Befehlstaste (Mac) gedrückt und ziehen Sie 
den Cursor nach oben oder unten, um zum 
gewünschten Wert zu gelangen.

• Spielen Sie das Controller-Event auf Ihrem 
MIDI-Controller-Keyboard und drücken Sie 
anschließend zum Bestätigen des Werts auf der 
Tastatur die Eingabetaste (Windows) bzw. 
die Return-Taste (Mac).

Wenn das Start-Feld aktiviert ist, können Sie 
die Position eines anderen, bereits auf der 
Spur vorhandenen Events automatisch 
übernehmen, indem Sie auf das entsprechende 
Event klicken.

Drücken Sie, während sich die MIDI Event-
Liste im Vordergrund befindet, Strg + L 
(Windows) bzw. Befehl + L (Mac), um ein 
Controller-Event einzufügen.

Event-Eingabefelder für Controller-Events

Wenn das Start-Feld aktiviert ist, können Sie 
die Position eines anderen, bereits auf der 
Spur vorhandenen Events automatisch 
übernehmen, indem Sie auf das entsprechende 
Event klicken.

Controller-Nummer Controller-Name

Controller-Wert
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3 Sie haben folgende Möglichkeiten:

• Um das Controller-Event einzufügen und weiter 
in den Event-Eingabefeldern zu arbeiten, 
drücken Sie die Enter-Taste auf dem 
Ziffernblock.

• Um das Controller-Event einzufügen und die 
Event-Eingabefelder zu verlassen, drücken Sie 
die Eingabetaste (Windows) bzw. die Return-
Taste (Mac) auf der Tastatur.

• Um die Event-Eingabefelder zu verlassen, ohne 
das Controller-Event einzufügen, drücken Sie 
die Esc-Taste auf der Tastatur.

So fügen Sie einen Program Change in die MIDI 
Event-Liste ein:

1 Wählen Sie im Menü der MIDI Event-Liste die 
Option Insert > Program Change.

2 Geben Sie die Position für das neue Event ein.

3 Geben Sie eine Program Change-Nummer und 
(falls erforderlich) einen Bank Select-Wert ein. 
Die Bezeichnung des Program Change wird in 
der Info-Spalte angezeigt.

Sie können in die Length/Info-Spalte klicken, 
um das Program Change-Fenster zu öffnen (siehe 
„Patch Select-Dialogfeld (Program und Bank 
Changes)“ auf Seite 715). 

4 Sie haben folgende Möglichkeiten:

• Um den Program Change einzufügen und weiter in 
den Event-Eingabefeldern zu arbeiten, drücken Sie 
die Enter-Taste auf dem Ziffernblock.

• Um einen Program Change einzufügen und die 
Event-Eingabefelder zu verlassen, drücken Sie 
die Eingabetaste (Windows) bzw. die Return-
Taste (Mac) auf der Tastatur.

• Um die Event-Eingabefelder zu verlassen, ohne 
den Program Change einzufügen, drücken Sie 
die Esc-Taste auf der Tastatur.

Einfügen eines weiteren Events
Nachdem Sie ein Event eingefügt haben, können 
Sie ganz einfach ein weiteres Event desselben 
Typs einfügen. Der einzufügende Event-Typ wird 
im unteren Bereich des Insert-Menüs angezeigt.

Beispiel: Wenn Sie nach dem Einfügen einer Note 
eine weitere einfügen möchten, gehen Sie 
folgendermaßen vor:

 Wählen Sie im Menü der MIDI Event-Liste die 
Option Insert > Another Note.

Drücken Sie, während sich die MIDI Event-
Liste im Vordergrund befindet, Strg + P 
(Windows) bzw. Befehl + P (Mac), um ein 
Program Change-Event einzufügen.

Event-Eingabefelder für Program Changes

Programmnummer Programmname

Wert des Controllers 0

Wert des Controllers 32

Wenn das Start-Feld aktiviert ist, können Sie 
die Position eines anderen, bereits auf der 
Spur vorhandenen Events automatisch 
übernehmen, indem Sie auf das entsprechende 
Event klicken.

Drücken Sie, während sich die MIDI Event-
Liste im Vordergrund befindet, Strg + M 
(Windows) bzw. Befehl + M (Mac), um eine 
Note einzufügen.

Wenn die Option „Insert At Playback 
Location“ aktiviert ist (siehe „Optionen für 
die MIDI Event-Liste“ auf Seite 787), 
können Sie mit der Tastenkombination zum 
Einfügen eines weiteren Events während 
der Wiedergabe Events einfügen.
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Bearbeiten von Events in der 
MIDI Event-Liste
Events in der MIDI Event-Liste können bearbeitet, 
ausgewählt, gelöscht sowie kopiert und eingefügt 
werden.

So bearbeiten Sie ein Event in der MIDI Event-
Liste:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie auf das Feld des betreffenden 
Events:

• Um ein selektiertes Event zu bearbeiten, 
drücken Sie Strg + Eingabe (Windows) bzw. 
Befehl + Return (Mac).

2 Sie haben folgende Möglichkeiten, einen Wert 
einzugeben:

• Geben Sie den neuen Wert über den 
Ziffernblock ein.

• Halten Sie die Alt-Taste (Windows) bzw. die 
Wahltaste (Mac) gedrückt, und drücken Sie dazu 
die Nach-oben-Pfeiltaste, um zum gewünschten 
Wert zu gelangen.

• Drücken Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) und ziehen Sie den Cursor 
nach oben oder unten, um den gewünschten 
Wert anzuzeigen.

• Spielen Sie die neue Note oder den Controller-
Wert auf Ihrem MIDI-Controller-Keyboard und 
drücken Sie zum Bestätigen des Werts auf der 
Tastatur die Eingabetaste (Windows) bzw. die 
Return-Taste (Mac).

3 Sie haben folgende Möglichkeiten:

• Um den neuen Event-Wert einzugeben und zu 
einem anderen Feld bzw. Event zu wechseln, 
verwenden Sie die Pfeiltasten.

• Um den neuen Wert einzugeben und weiter in 
den Event-Eingabefeldern zu arbeiten, drücken 
Sie die Enter-Taste auf dem Ziffernblock.

• Um den neuen Wert einzugeben und die Event-
Eingabefelder zu verlassen, drücken Sie die 
Eingabetaste (Windows) bzw. die Return-Taste 
(Mac) auf der Tastatur.

• Um die Event-Eingabefelder zu verlassen, ohne 
einen neuen Wert einzugeben, drücken Sie die 
Esc-Taste auf der Tastatur.

Selektieren von Events in der 
MIDI Event-Liste

So wählen Sie eine Folge von Events in der MIDI 
Event-Liste aus:

 Klicken Sie auf das erste gewünschte Event und 
ziehen Sie den Cursor bis zum letzten Event.

 Klicken Sie bei gedrückter Umschalttaste auf 
das erste gewünschte Event und anschließend 
auf das letzte.

So wählen Sie nicht benachbarte Events in der 
MIDI Event-Liste aus:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) oder Befehlstaste (Mac) auf jedes 
einzelne Event.

So heben Sie die Auswahl eines Events in der MIDI 
Event-Liste auf:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) oder Befehlstaste (Mac) auf das 
ausgewählte Event.

In der MIDI Event-Liste ausgewählte Noten 
können durch jeden Befehl im Event 
Operations-Fenster geändert werden 
(siehe Kapitel 41: „Event Operations“).
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Löschen von Events aus der 
MIDI Event-Liste

So löschen Sie ein Event aus der MIDI Event-Liste:

 Klicken Sie bei gedrückter Alt-Taste (Windows) 
oder Wahltaste (Mac) auf das zu löschende 
Event.

So löschen Sie eine Auswahl von Events aus der 
MIDI Event-Liste:

1 Wählen Sie die zu löschenden Events durch 
Ziehen in der Start-Spalte oder durch Klicken 
auf die einzelnen Events bei gedrückter 
Umschalttaste aus.

2 Um nur die Events anzuzeigen, die 
gelöscht werden sollen, verwenden Sie den 
Ansichtsfilter (siehe „Ansichtsfilter für die 
MIDI Event-Liste“ auf Seite 780). Nicht 
angezeigte Events können nicht gelöscht 
werden.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Clear, um alle ausgewählten 
Events zu löschen.

• Drücken Sie die Rücktaste (Windows) bzw. die 
Entf-Taste (Mac) auf der Tastatur.

Kopieren und Einfügen von 
Events in der MIDI Event-Liste

So können Sie Events in der MIDI Event-Liste 
kopieren und an anderer Position einfügen:

1 Wählen Sie in der MIDI Event-Liste die Events 
aus, die Sie kopieren möchten.

2 Wählen Sie Edit > Copy.

3 Sie haben folgende Möglichkeiten:

• Um das Material an der Position eines bereits 
vorhandenen Events einzufügen, klicken Sie in 
der MIDI Event-Liste auf das entsprechende 
Event.

• Um das Material an einer anderen beliebigen 
Position einzufügen, wählen Sie im Options-
Menü in der MIDI Event-Liste die Go To-
Option aus. Dann geben Sie die Position ein, 
an der das Material eingefügt werden soll, und 
klicken auf „OK“.

4 Wählen Sie „Edit > Paste“. Die Events aus der 
Zwischenablage werden eingefügt und ersetzen 
alle bis dahin an dieser Stelle vorhandenen Events.

Auswählen in der MIDI Event-Liste

Um Events einzufügen, ohne vorhandene 
Events zu überschreiben, verwenden Sie den 
Merge Paste Special-Befehl.
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Optionen für die MIDI Event-
Liste
Das Menü der MIDI Event-Liste umfasst folgende 
Optionen:

Show Sub Counter. zeigt die Event-Zeiten im 
Nebenzähler an.

Go To. – öffnet das Go To-Dialogfeld, in das Sie 
eine auf einer der eingerichteten Zeitskalen 
basierende Position eingeben können, an die der 
Edit-Einfügepunkt verschoben wird.

Scroll To Edit Selection. – geht in der MIDI 
Event-Liste zum Edit-Startpunkt oder Edit-
Einfügepunkt.

Page Scroll During Playback. – scrollt die MIDI 
Event-Liste während der Wiedergabe.

Show Note Length. – zeigt in der Length/Info-
Spalte der MIDI Event-Liste statt Start- und 
Endpunkt die Notenlängen an.

Show Note End Time. – zeigt in der Length/Info-
Spalte der MIDI Event-Liste statt Notenlängen die 
Endpunkte der Noten an.

Insert. – bietet ein Untermenü mit Optionen zum 
Einfügen aller MIDI-Event-Typen.

Insert At Edit Location. – weist eingefügten 
Events als Standard die Position des Edit-
Startpunkts bzw. Edit-Einfügepunkts zu.

Insert At Playback Location. – ermöglicht 
während der Session-Wiedergabe das Einfügen 
von Events in die MIDI Event-Liste in Echtzeit. 

Insert At Playback Location With Grid. – richtet 
die Position von in Echtzeit eingefügten Events 
automatisch am Raster aus.

View Filter. – öffnet das View Filter-Dialogfeld, 
in dem Sie festlegen können, welche Events in der 
MIDI Event-Liste angezeigt werden (siehe 
„Ansichtsfilter für die MIDI Event-Liste“ auf 
Seite 780).
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Kapitel 35: Zeit, Tempo, Taktart, Tonart 
und Akkorde

Das Editieren und Anordnen von Spuren erfolgt 
bei Pro Tools in der Regel innerhalb einer 
vorgegebenen Timeline. 

Clips und Events können an Punkten der absoluten 
oder relativen Zeit, wie in der Timeline der Session 
gemessen, verankert werden. Die Timeline enthält 
zwei Leistentypen zur Zeitmessung: Zeitbasis- und 
Dirigentenleisten.

Die Zeitbasis-Leisten bieten zwei Möglichkeiten 
der Zeitmessung: samplebasierte Zeit (absolute 
Zeit) und tickbasierte Zeit (relative Zeit). Die 
Leiste „Minutes:Seconds“ misst beispielsweise die 
absolute Zeit und die Leiste „Bars|Beats“ misst die 
relative Zeit.

Die relative Zeit der Leiste „Bars|Beats“ ergibt 
sich teilweise aus dem Tempo und der Taktart. Die 
Leisten „Tempo“, „Meter“ und „Key Signature“ 
befinden sich in den Dirigentenspuren. Tempo- 
und Taktartänderungen wirken sich auf das 
Timing tickbasierter Spuren aus und geben 
außerdem die Tempo- und Taktartzuweisung für 
das Bar|Beat-Raster und das Metronom. Sie 
können Tempo-Events in der Tempo-Leiste oder 
im Tempo-Editor bearbeiten. 

Tonartänderungen können sich bei der Vornahme 
einer Transposition auf MIDI-Noten auswirken. 
Tonarten und Tonartänderungen können in der Key 
Signature-Leiste bearbeitet werden.

Zeitbasis- und 
Dirigentenleisten

Zeitbasis-Leisten
Sie können sowohl einzelne als auch alle 
Zeitbasis-Leisten oben im Edit-Fenster oder in 
Fenstern im MIDI Editor anzeigen:

Bars|Beats. – mit dieser Option wird die Zeitskala 
in Takten und Schlägen angezeigt. Benutzen Sie 
diese Zeitskala, wenn Sie mit Musikmaterial 
arbeiten, das sich an Taktstriche und Schläge 
anpassen soll. Die Zeitskala bei „Bars|Beats“ ist 
relativ und hängt von der Tempo- und 
Taktartzuweisung der Session ab.

Pro Tools bietet auch eine Markers-Leiste 
für Memory Locations (siehe Kapitel 36: 
„Memory Locations“).

Anzeigen aller Leisten 
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Minutes:Seconds. – diese Option zeigt die 
Zeitskala in Minuten und Sekunden an. Wenn Sie 
die Anzeige mithilfe des Zoomer-Tools immer 
weiter vergrößern, zeigt die Zeitskala Zehntel-, 
Hundertstel- und Tausendstelsekunden an. Die 
Zeitskala bei „Minutes:Seconds“ ist absolut.

Timecode. – diese Option zeigt die Zeitskala 
in SMPTE-Frames an. Die Timecode-Rate und 
die Startzeit der Session werden über 
das Session Setup-Fenster eingestellt. 
Die Zeitskala bei „Timecode“ ist absolut und 
basiert auf der Framerate.

Pro Tools unterstützt folgende Framerates:

• 23,976 FPS

• 24 FPS

• 25 FPS

• 29,97 FPS

• 29,97 FPS Drop

• 30 FPS

• 30 FPS Drop

Sekundäre Timecode-Leiste. – über die sekundäre 
Timecode-Leiste „Time Code 2“ können Sie in der 
Timeline Video-Framerates referenzieren, die von 
der Timecode-Rate der Session abweichen. 
Sie können jedoch keine Positionierung auf der 
Timecode 2-Leiste erstellen und sie kann nicht als 
Haupt-Zeitskala (Main Time Scale) eingerichtet 
werden. Die sekundäre Timecode-Leiste kann 

so eingerichtet werden, dass von Pro Tools 
unterstützte Framerates angezeigt werden. Daneben 
kann die Timecode 2-Leiste die folgenden 
zusätzlichen Framerates anzeigen:

• 50 FPS

• 59,94 FPS

• 59,94 FPS Drop

• 60 FPS

• 60 FPS Drop

Feet+Frames. – diese Option zeigt die Zeitskala in 
den Einheiten Fuß und Frames (Feet.Frames) an 
und kann so als Referenz für 
Filmvertonungsprojekte dienen. 
Die Feet+Frames-Anzeige basiert auf dem 
35-mm-Filmformat. Die Zeitskala 
bei „Feet+Frames“ ist absolut und basiert auf der 
Framerate.

Samples. – diese Option zeigt die Zeitskala 
in Samples an. Dieses Format ist für das präzise 
Editieren von Samples sehr hilfreich. 
Die Zeitskala bei „Samples“ ist absolut und basiert 
auf der Samplerate.

Die Zeitbasis-Leisten dienen nicht nur als Timing-
Referenz für Spurmaterial, sie werden auch 
verwendet, um Edit-Selektionen für Spurmaterial 
und Timeline-Selektionen für Aufnahme- und 
Wiedergabebereiche zu definieren.

Achten Sie darauf, dass Sie alle Spuren mit dem 
Metronom aufnehmen, damit sie sich in das 
vorgegebene Taktraster einer Session einfügen 
(siehe „Aufnehmen mit dem Metronom“ auf 
Seite 430). Material, das ohne Metronom 
aufgenommen wurde, kann in Pro Tools mit dem 
Identify Beat-Befehl (siehe „Identify Beat-
Befehl“ auf Seite 818) oder mit Beat Detective 
(siehe Kapitel 30: „Beat Detective“) am 
Taktraster ausgerichtet werden.

Mit dem Selector-Tool können Sie im Edit- oder 
MIDI Editor-Fenster in einer beliebigen 
Zeitbasis-Leiste Material aus allen Spuren 
durch Ziehen markieren und selektieren. 
Um die Dirigentenspuren in die Selektion 
einzubeziehen, drücken Sie während 
des Ziehens die Alt-Taste (Windows) 
bzw. die Wahltaste (Mac).



Kapitel 35: Zeit, Tempo, Taktart, Tonart und Akkorde 793

Dirigentenleisten
Sie können eine oder mehrere der folgenden 
Dirigentenleisten anzeigen:

• Marker

• Tempo (und Tempo-Editor)

• Pegelanzeige

• Keys (und Key Signature Staff)

• Chords

Die Meter-Leiste und die Tempo-Leiste zeigen 
innerhalb einer Session Änderungen in der Taktart 
und im Tempo an. Die Key Signature-Leiste zeigt 
Änderungen der Tonart an. Die Chord Symbols-
Leiste zeigt Akkord-Marker an. Die Markers-
Leiste zeigt Marker an wichtigen Stellen in der 
Spur an.

Anzeigen von Leisten

So zeigen Sie alle Leisten an:

 Aktivieren Sie View > Rulers > All.

Sie haben folgende Möglichkeiten, um eine Leiste 
aus der Anzeige zu entfernen:

 Klicken Sie bei gedrückter Wahltaste auf den 
Namen der Leiste (links neben der Leiste).

 Wählen Sie View > Rulers und deaktivieren 
Sie eine Leistenoption.

So zeigen Sie in der Zeitbasis-Leiste lediglich die 
Haupt-Zeitskala an:

 Aktivieren Sie View > Rulers > None 
(siehe „Haupt-Zeitskala“ auf Seite 794).

So fügen Sie der Anzeige eine bestimmte Leiste, 
beispielsweise die Markers-Leiste, hinzu:

 Aktivieren Sie View > Rulers > Marker.

So ändern Sie die Reihenfolge der 
angezeigten Leisten:

 Klicken Sie auf den Namen eines Lineals und 
ziehen Sie ihn an die gewünschte Stelle.

So kopieren Sie die Bereichsselektion aus einer 
Dirigentenleiste, um in der oberen Spur 
im Edit-Fenster (oder im Fensterbereich „Notes“ 
in den MIDI Editor-Fenstern) eine Edit-
Selektion vorzunehmen:

 Drücken Sie ctrl + ; (Semikolon, Mac) bzw. 
Start + ; (Semikolon, Windows).

Ruler View-Selektor
Die Zeitbasis- und Dirigentenleisten können auch 
über den Ruler View-Selektor konfiguriert werden.

Weitere Informationen zu Memory Location-
Markern finden Sie unter Kapitel 36: 
„Memory Locations“.

Ruler View-Selektor im Edit-Fenster.
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Haupt-Zeitskala
Alle Zeitbasis-Leisten können gleichzeitig im Edit-
Fenster und in den MIDI Editor-Fenstern angezeigt 
werden. Die Anzeige der Haupt-Zeitskala erfolgt 
jedoch nur über eine einzige Leiste. Diese Leiste wird 
auch Haupt-Zeitbasis-Leiste genannt. 

Die Haupt-Zeitskala bestimmt das Zeitformat 
folgender Elemente:

• Hauptzähler im Transport-Fenster

• Hauptzähler oben im Edit-Fenster oder 
MIDI Editor-Fenster

• Start-, End- und Length-Felder

• Pre- und Post-Roll-Zeiten

• Raster- und Nudge-Werte

Die Haupt-Zeitskala kann auf die folgenden 
Formate eingestellt werden:

• Bars|Beats 

• Minuten:Sekunden

• Timecode

• Feet+Frames

• Samples

Einstellen der Haupt-Zeitskala

Zum Einstellen der Haupt-Zeitskala haben 
Sie folgende Möglichkeiten:

 Klicken Sie auf einen Main Counter-Selektor 
(oben im Edit- oder Transport-Fenster, 
wenn Zähler angezeigt werden) und wählen Sie 
eine Zeitskala aus.

 Wenn eine Zeitbasis-Leiste angezeigt wird, 
klicken Sie auf ihren Namen, sodass sie 
hervorgehoben wird.

Navigieren mit den Hauptzählern
Die Hauptzähler (oben im Edit- und im Transport-
Fenster) bieten eine bequeme Möglichkeit zum 
Navigieren zu einer bestimmten zeitlichen Position. 

So navigieren Sie mit einem Hauptzähler:

1 Klicken Sie in einen Hauptzähler.

2 Geben Sie eine Position ein.

3 Drücken Sie die Eingabetaste (Windows 
oder Mac) oder die Return-Taste (Mac), 
um automatisch an eine neue Position 
zu navigieren.

Hauptzähler-Selektor (im Edit-Fenster)

Wenn Sie die Haupt-Zeitskala auf die derzeit 
im Nebenzähler angezeigte Zeitbasis 
einstellen, werden die zwei Zeitskalen 
vertauscht, d. h., die Sub-Zeitskala wird auf 
die Haupt-Zeitskala eingestellt.

Umschalten der Haupt-Zeitskala von „Bars|Beats“ 
auf „Min:Sec“

Der Hauptzähler im Transport-Fenster wird 
nur angezeigt, wenn die Anzeige von Zählern 
für den Transport aktiviert ist.
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Nebenzähler
Unter jedem Hauptzähler befindet sich 
ein Nebenzähler, der ein- oder ausgeblendet 
werden kann. Der Nebenzähler bietet eine 
zusätzliche Timing-Referenz.

So können Sie den Nebenzähler im Edit-Fenster 
einblenden (oder ausblenden):

 Aktivieren (oder deaktivieren) Sie im Main 
Counter-Selektor die Option Show Sub Counter. 

So zeigen Sie den Nebenzähler im Transport-
Fenster an:

 Überprüfen Sie im Menü des Transport-
Fensters, dass die Optionen Counters und 
Expanded Transport aktiviert sind.

So stellen Sie die Zeitskala für den Nebenzähler ein:

 Klicken Sie auf den Sub Counter-Selektor und 
wählen Sie eine Zeitskala.

Tickbasiertes Timing
Pro Tools ist ein samplebasiertes Programm mit 
einer internen MIDI-Auflösung von 
960.000 Impulsen pro Viertelnote (ppq). Wird die 
Zeitskala jedoch auf „Bars|Beats“ eingestellt, 
beträgt die Anzeigeauflösung in Pro Tools 
960 ppq und die Zeitbasis ist tickbasiert. 

Wenn Sie mit der Einstellung „Bars|Beats“ 
arbeiten, benötigen Sie für einige Arbeitsschritte 
die genauen Angaben der Tick-Werte. 
Beispiele hierfür sind:

• Platzieren und Spotting von Clips

• Einstellen der Länge von Clips oder MIDI-Noten

• Auffinden und Einstellen von Aufnahme- 
und Wiedergabebereichen (inklusive Pre- und 
Post-Roll)

• Angeben von Einstellungen auf der Quantize- 
und Change Duration-Seite des Event 
Operations-Fensters

• Einstellen der Grid- und Nudge-Werte

Sub Counter-Selektor (im Edit-Fenster)

In der Zeitskala bei „Bars|Beats“ arbeitet 
Pro Tools tickbasiert (960 Ticks 
pro Viertelnote). Das bedeutet, dass beim 
Einfügen von Events an bestimmten 
Positionen Sample-Rundungen auftreten 
können (siehe „Sample-Rundungen und 
Editiervorgänge“ auf Seite 798).

Wenn die Haupt-Zeitskala auf „Bars|Beats“ 
eingestellt ist und Sie Tempowechsel 
verwenden, stellen Sie den Linearitäts-
Anzeigemodus auf „Linear Tick Display“ 
ein (siehe „Ändern des Linearitäts-
Anzeigemodus“ auf Seite 811). Dadurch 
wird die Leiste „Bars|Beats“ 
(auf der ausgewählten Zoom-Stufe) fixiert 
und samplebasierte Leisten, 
wie „Minutes:Seconds“, werden für alle 
Tempowechsel skaliert, während 
die Taktlänge konstant bleibt. 
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In der folgenden Tabelle sind die Tick-Werte 
für die gebräuchlichsten Notenwerte aufgelistet:

Tick- und samplebasierte 
Zeitbasen
Mit Pro Tools können Sie die Spur-Zeitbasis 
sample- oder tickbasiert festlegen.

Audiospuren basieren in Pro Tools standardmäßig 
auf Samples. Damit befinden sich Audioclips und -
Events an spezifischen Samplepositionen, 
die sie auch bei Tempowechseln in der Session 
nicht verlassen – selbst wenn sich ihre 
Taktpositionen ändern.

MIDI- und Instrumentenspuren basieren 
in Pro Tools standardmäßig auf Ticks. 
Damit befinden sich MIDI-Clips und -Events 
an spezifischen Taktpositionen, die sie auch 
bei Tempowechseln in der Session nicht verlassen– 
selbst wenn sich ihre Samplepositionen ändern.

Samplebasiertes Audio- und 
MIDI-Material
Bei einer samplebasierten Audiospur haben alle 
Audioclips in der Spur eine absolute Position auf der 
absoluten Timeline (zum Beispiel auf der Zeitbasis-
Leiste „Samples“ oder „Minutes:Seconds“). 
Auch bei Tempo- und Taktartänderungen in einer 
Session bleibt das Audiomaterial an die 
Samplezeit gebunden.

Bei samplebasierten MIDI- und Instrumentenspuren 
haben alle MIDI-Events in der Spur eine absolute 
Position auf der absoluten Timeline (zum Beispiel auf 
der Zeitbasis-Leiste „Samples“ oder 
„Minutes:Seconds“). Auch bei Tempo- und 
Taktartänderungen in einer Session bleiben die MIDI-
Events an die Samplezeit gebunden.

Tickbasiertes Audio- und 
MIDI-Material
Tickbasiertes Audiomaterial ist an die relative Zeit 
der „Bars|Beats“-Zeitbasis-Leiste gebunden und 
bewegt sich bei Tempo- und Taktartänderungen 
relativ zur Sample-Timeline. Hinsichtlich der Länge 
reagieren MIDI- und Elastic Audio-Events und 
tickbasierte Audioclips (nicht Elastic Audio) 
allerdings unterschiedlich auf Tempowechsel. 
Die Länge von MIDI-Noten-Events und Elastic 
Audio-Clips ändert sich bei einer Änderung des 
Tempos, während sie bei anderen Audioclips als 
Elastic Audio gleich bleibt. Tempowechsel wirken 
sich bei einer tickbasierten Audiospur (nicht Elastic 
Audio) nur auf die Anfangsposition (oder den Sync-
Punkt) jedes Audioclips aus.

Sie können entweder bereits bei der 
Spurenerstellung bestimmen, ob eine Spur sample- 
oder tickbasiert sein soll, oder die Zeitbasis 
später ändern. 

Notenwert Normal Punktiert Triolisch

Halbe Note 1920 2880 1280

1/4-Note 960 1440 640

1/8-Note 480 720 320

1/16-Note 240 360 160

1/32-Note 120 180 180

1/64-Note 160 90 240

Um festzulegen, dass alle neuen Spuren 
standardmäßig auf Ticks basieren, aktivieren 
Sie in den Editing-Voreinstellungen die Option 
„New Tracks Default to Tick Timebase“.
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Tickbasierte Elastic Audio-
Spuren
Tickbasierte Elastic Audio-Spuren wenden bei 
einem Tempowechsel automatisch die in Echtzeit 
durchgeführte (oder gerenderte) Elastic Audio-
Verarbeitung (TCE) an. Weitere Informationen 
finden Sie unter „Tempowechsel und tickbasierte 
Elastic Audio-Spuren“ auf Seite 804.

Ändern der Zeitbasis
Alle Pro Tools-Spuren können von sample- 
zu tickbasiert (und umgekehrt) geändert werden.

Die Darstellungshöhe der Spuren beeinflusst die Art 
und Weise, wie die verschiedenen Spur-
Steuerelemente im Edit-Fenster angezeigt werden. 
Der für die Umschaltung der Zeitbasis einer Spur 
verwendete Timebase-Selektor wird nur bei mittleren 
oder großen Spurhöhen angezeigt.

Beim Ändern der Zeitbasis einer Spur haben 
Sie folgende Möglichkeiten:

 Wenn die Darstellungshöhe der Spur auf 
„Medium“ oder größer eingestellt ist, klicken 
Sie auf den Timebase-Selektor der Spur und 
wählen die Zeitbasis aus. Das Timebase-
Selektorsymbol ändert sich entsprechend.

.

.

 Wenn die Spurhöhe auf „Small“ (oder kleiner) 
eingestellt ist, klicken Sie auf den Track Height-
Selektor und wählen aus dem Track Timebase-
Untermenü die Zeitbasis aus.

Alternative Playlist-Zeitbasen
Beim Ändern der Zeitbasis einer Spur können 
Sie auswählen, ob die Änderung nur auf diese Spur 
oder auf die aktive Playlist und alle alternativen 
Playlists dieser Spuren angewendet werden soll. 

So konfigurieren Sie eine Zeitbasis-Änderung 
für alle Playlists in einer Spur:

 Klicken Sie auf den Timebase-Selektor 
(oder den Track Height-Selektor) und 
aktivieren Sie die Option Selection Changes 

Alternate Playlists. 

Gruppen
Beim Ändern der Zeitbasis einer Audiospur, 
die Teil einer aktiven Edit-Gruppe ist, wirkt sich 
die Änderung auf alle Spuren in der Gruppe aus.

Timebase-Selektor (Samples)

Timebase-Selektor (Ticks)

Track Height-Popup-Menü
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Position von Audioclips
Bei tickbasierten Audiospuren wird die Position eines 
Audioclips vom Startpunkt des Clips bestimmt, es sei 
denn, der Clip enthält einen Sync-Punkt.

In diesem Fall legt der Sync-Punkt die Position 
fest, an der der Audioclip mit dem Raster 
verbunden ist. 

Marker-Position
Wenn Sie Marker- und Selection-Memory 
Locations erstellen, können diese entweder eine 
absolute (samplebasierte) oder eine (tickbasierte) 
Bar|Beat-Referenz haben. Weitere Informationen 
finden Sie unter „Bar|Beat and Absolute Reference“ 
auf Seite 841.

Sample-Rundungen und 
Editiervorgänge
Wenn Audiomaterial in Pro Tools auf Samples basiert, 
können bei einigen Editiervorgängen Sample-
Rundungen auftreten, wenn die Haupt-Zeitskala auf 
„Bars|Beats“ eingestellt ist. Das fällt besonders dann 
auf, wenn Audioclips (wie beim Loopen) exakt auf dem 
Beat liegen müssen, das Material jedoch um einen oder 
zwei Ticks davon abweicht. Sie können dieses Problem 
jedoch umgehen, wenn Sie bestimmte Vorkehrungen 
treffen:

Um sicherzustellen, dass Selektionen beim 
Loopen, Kopieren, Duplizieren oder Wiederholen 
präzise am Raster ausgerichtet sind, beachten 
Sie Folgendes: 

 Aktivieren Sie bei Verwendung des Selector-Tools 
den Grid-Modus und wählen Sie den geeigneten 
Rasterwert (etwa Sechzehntelnoten) aus.

 Geben Sie im Event Edit-Bereich den Start- und 
Endpunkt der Selektion ein, um eine 
größtmögliche Genauigkeit zu erreichen. 

 Selektieren Sie das Material nicht mit einem 
Grabber-Tool (oder durch Doppelklicken mit dem 
Selector-Tool). 

Songstart-Marker
Mit dem Songstart-Marker wird das anfängliche 
Tempo von Bar|Beat-basiertem Material definiert. 
Neue Sessions werden mit einem Standardtempo 
von 120 BPM geöffnet.

Bei einer neuen Session ist dem Songstart-Marker 
kein Taktart-Event zugewiesen. Ein solches wird 
automatisch am Songstart hinzugefügt , wenn Sie 
ein Taktart-Event an einer beliebigen Stelle der 
Meter-Leiste hinzufügen.

Der Songstart-Marker kann zwar verschoben, aber 
nicht gelöscht werden.

So verschieben Sie den Songstart-Marker 
durch Ziehen:

 Ziehen Sie den Songstart-Marker mit einem 
Edit-Tool in der Tempoleiste nach rechts 
oder links.

Songstart-Marker

Die Position des Songstart-Markers 
kann auch im Time Operations-Fenster 
geändert werden (siehe „Move Song Start“ 
auf Seite 829).

Ziehen des Songstart-Markers



Kapitel 35: Zeit, Tempo, Taktart, Tonart und Akkorde 799

Wenn der Edit-Modus auf „Grid“ eingestellt ist, 
wird der Songstart-Marker entsprechend dem 
aktuellen Rasterwert verschoben. 

So bearbeiten Sie das anfängliche Tempo 
im Songstart-Marker:

1 Doppelklicken Sie in der Tempoleiste auf den 
Songstart-Marker.

2 Geben Sie im Change Tempo-Dialogfeld einen 
neuen BPM-Wert ein.

3 Klicken Sie auf OK.

Tempo
Mit der Tempoleiste können Sie Tempo-Events 
einzeln oder gemäß Tempokurven bearbeiten. Sie 
können das Tempo visuell im Tempo-Editor 
bearbeiten oder im Tempo Operations-Fenster 
präzise Änderungen vornehmen. 

So zeigen Sie die Tempoleiste an:

 Aktivieren Sie View > Rulers > Tempo.

Tempo-Events
Tempo-Events können dem Songstart-Marker 
zugewiesen werden, um das Standardtempo 
(120 BPM) zu ersetzen, und dann zur Vornahme 
eines Tempowechsels an einer beliebigen Stelle in 
der Session eingefügt werden. 

Aktuelles Tempo

Das aktuelle Tempo der Session wird bei der 
Wiedergabe von den Tempo-Events bestimmt und 
im Transport-Fenster angezeigt.

Wenn Sie nur den Songstart-Marker 
und keine tickbasierten Daten verschieben 
möchten, drücken Sie während des 
Ziehens Windows + Umschalt (Windows) 
bzw. ctrl + Umschalt (Mac). Wenn Sie nur 
den Songstart-Marker ziehen, kann er nur 
taktweise verschoben werden. 

Informationen zum Einstellen des 
Standardtempos einer Session finden Sie 
unter „Festlegen von Taktart und Tempo“ 
auf Seite 433.

Mit dem Beat Detective können Sie Bar|Beat-
Marker (Tempo-Map) erzeugen. Weitere 
Informationen finden Sie unter „Erzeugen 
von Bar|Beat-Markern mit Beat Detective“ 
auf Seite 676.

Wenn Sie mit Tempowechseln und 
tickbasiertem Material arbeiten, stellen Sie 
den Linearitäts-Anzeigemodus auf „Linear 
Tick Display“ ein. 

Im Manual Tempo-Modus wird die Tempoleiste 
ignoriert und die Session wird entsprechend 
dem im Transport-Fenster eingestellten Tempo 
wiedergegeben (siehe „Verwenden des Manual 
Tempo-Modus“ auf Seite 434).

Aktuelles Tempo im Transport-Fenster
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Einfügen von Tempo-Events

So fügen Sie ein Tempo-Event ein:

1 Klicken Sie auf die Stelle in der Tempoleiste, an 
der Sie ein neues Tempo-Event 
einfügen möchten.

2 Klicken Sie auf die Add Tempo Change-
Schaltfläche links von der Tempoleiste.

3 Geben Sie im Tempo Change-Fenster die 
Position und den BPM-Wert für den 
Tempowechsel ein. 

4 Wählen Sie die Snap To Bar-Option, damit das 
eingefügte Tempo-Event genau auf den ersten 
Beat des nächstgelegenen Takts fällt. 

5 Wenn der BPM-Wert für einen anderen Notenwert 
als die vorgegebene Viertelnote gelten soll, 
wählen Sie einen anderen Notenwert.

6 Klicken Sie auf OK. Das neue Tempo-Event 
wird eingefügt und erscheint nun in 
der Tempoleiste.

Die Position eines jeden Tempo-Events wird durch 
ein kleines grünes Dreieck angezeigt. Das Dreieck 
kann gezogen werden, um das Tempo-Event zu 
verschieben. Durch Doppelklicken auf ein solches 
Dreieck kann das Tempo-Event bearbeitet werden.

Verschieben und Bearbeiten von 
Tempo-Events
Vorhandene Tempo-Events können verschoben, 
bearbeitet, gelöscht, kopiert und eingefügt werden.

So verschieben Sie ein Tempo-Event durch Ziehen:

 Ziehen Sie das Dreieck für das Tempo-Event in 
der Tempoleiste nach rechts oder links.

Wenn der Edit-Modus auf „Grid“ eingestellt ist, 
wird das gezogene Event automatisch entsprechend 
dem aktuellen Rasterwert positioniert. 

So bearbeiten Sie ein Tempo-Event:

1 Doppelklicken Sie in der Tempoleiste auf das 
Tempo-Event.

2 Geben Sie im Tempo Change-Dialogfeld eine 
neue Position oder einen neuen BPM-Wert 
für das Tempo-Event ein.

3 Klicken Sie auf OK.

Add Tempo Change (Schaltfläche)

Change Tempo-Dialogfeld

Eingefügtes Tempo-Event

Ziehen eines Tempo-Events



Kapitel 35: Zeit, Tempo, Taktart, Tonart und Akkorde 801

So löschen Sie ein Tempo-Event:

 Klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) auf das 
Tempo-Event (der Cursor ändert sich zu einem 
Grabber mit einem „–“).

So kopieren Sie mehrere Tempo-Events und fügen 
sie an anderen Positionen ein:

1 Selektieren Sie mit dem Selector-Tool durch 
Ziehen in der Tempoleiste den Taktbereich, 
der die Tempo-Events enthält.

2 Wählen Sie Edit > Copy.

3 Klicken Sie in der Tempoleiste auf die Stelle, 
an der Sie die Tempo-Events einfügen möchten.

4 Wählen Sie Edit > Paste. Der Inhalt der 
Zwischenablage wird am gewählten 
Einfügepunkt eingefügt. Alle bis dahin dort 
vorhandenen Tempo-Events werden ersetzt.

So erweitern Sie die Edit-Selektion in einer 
Spur auf die Tempoleiste:

1 Nehmen Sie mit dem Selector- oder Grabber-
Tool eine Timeline-Selektion vor.

2 Klicken Sie bei gedrückter Umschalttaste 
auf die Tempoleiste. 

So selektieren Sie sämtliche Tempo-Events:

 Doppelklicken Sie mit dem Selector-Tool 
auf die Tempoleiste.

So löschen Sie die Tempo-Events in einem 
selektierten Bereich:

1 Stellen Sie den Edit-Modus gegebenenfalls 
auf „Grid“ ein, um die Selektion durch 
das aktuell eingestellte Raster zu begrenzen. 

2 Ziehen Sie mit dem Selector-Tool über einen 
Bereich der Tempoleiste, um die zu löschenden 
Tempo-Events zu selektieren.

3 Wählen Sie Edit > Clear, um die selektierten 
Tempo-Events zu löschen.

Tempoeingabe durch Antippen 
von Tasten
Sie können das Tempo für eine Pro Tools-Session 
manuell eingeben, indem Sie eine Taste auf der 
Computertastatur mehrmals drücken. Sie können 
dazu auch ein verbundenes MIDI-Keyboard 
verwenden.

So stellen Sie das manuelle Tempo durch Tippen 
auf der Computertastatur ein:

1 Um die MIDI-Steuerelemente im Transport-
Fenster anzuzeigen, wählen Sie View > 

Transport > MIDI Controls.

2 Klicken Sie im Transport-Fenster auf die 
Schaltfläche „Tempo Ruler Enable 
(Conductor)“, um diese zu deaktivieren. 
Pro Tools schaltet in den Manual Tempo-
Modus um. In diesem Modus werden sämtliche 
Tempo-Events in der Tempo-Leiste ignoriert.

Selektierte Tempo-Events

Um eine Selektion in allen Dirigentenspuren 
vorzunehmen, halten Sie beim Ziehen die Alt-
Taste (Windows) bzw. die Wahltaste 
(Mac) gedrückt.

Tempo Ruler-Schaltfläche (deaktiviert), Manual 
Tempo-Modus eingestellt
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3 Klicken Sie in das Tempo-Feld, sodass 
es hervorgehoben wird, und tippen Sie die 
T-Taste Ihrer Computertastatur mehrmals in der 
gewünschten Geschwindigkeit an.

So stellen Sie das manuelle Tempo durch Tippen 
auf einem externen MIDI-Keyboard ein:

1 Um die MIDI-Steuerelemente im Transport-
Fenster anzuzeigen, wählen Sie View > 

Transport > MIDI Controls.

2 Wählen Sie Setup > Preferences und klicken 
Sie auf die MIDI-Registerkarte.

3 Stellen Sie sicher, dass Use MIDI to Tap Tempo 
aktiviert ist.

4 Klicken Sie im Transport-Fenster 
auf die Schaltfläche „Tempo Ruler Enable 
(Conductor)“, um diese zu deaktivieren. 
Pro Tools schaltet in den Manual Tempo-
Modus um. In diesem Modus werden sämtliche 
Tempo-Events in der Tempo-Leiste ignoriert.

5 Klicken Sie in das Tempo-Feld, sodass 
es hervorgehoben wird, und geben Sie das 
Tempo ein, indem Sie im entsprechenden 
Tempo eine Note wiederholt auf Ihrem MIDI-
Keyboard-Controller spielen.

Zum Berechnen des neuen Tempos ermittelt 
Pro Tools die durchschnittliche Geschwindigkeit, 
mit der die letzten acht (oder weniger) Noten 
eingespielt wurden. Der berechnete BPM-Wert 
erscheint im Tempo-Feld des Transport-Fensters.

Tempo und Automation Drifting
(Nur bei samplebasierten Clips 
auf tickbasierten Spuren)

Bei samplebasierten Spuren wirken sich 
Tempowechsel nicht auf die Automations-Playlist 
der Spur aus. Die Automation wird damit bei 
jeglichem samplebasierten Audiomaterial auf der 
Spur mit Sample-Genauigkeit ausgerichtet.

Bei tickbasierten Spuren ändern sich die 
Automation Breakpoints und passen sich 
an das geänderte Tempo an. 

Dies ist bei der Verwendung von Tempowechseln 
bei tickbasiertem MIDI und Elastic Audio generell 
positiv. Es kann deshalb empfehlenswert sein, 
alle Spuren in Ihrer Session mit Automation 
auf tickbasiert einzustellen. Auf diese Weise 
wirken sich Tempowechsel gleichermaßen 
auf jede tickbasierte Spur-Automation und jedes 
Spurmaterial aus. Wenn Sie dagegen 
samplebasiertes Audiomaterial (nicht Elastic 
Audio) auf tickbasierten Spuren verwenden, 
wirken sich Tempowechsel auf die Startposition 
von Audioclips, aber nicht auf deren Dauer aus.

Sie können das neue Tempo auf die gesamte 
Session anwenden, indem Sie das Standardtempo 
des Songstart-Markers ändern. Siehe „Songstart-
Marker“ auf Seite 798.
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Da die Länge von samplebasierten Audioclips 
in einer Spur von Tempowechseln nicht betroffen 
ist, sind bestehende Automationsdaten nach einem 
Tempowechsel bei einer tickbasierten Audiospur 
nicht an das Audiomaterial angepasst. 

Minimieren von Automation Drifting

Im Allgemeinen ist Automation Drifting 
bei längeren samplebasierten Audioclips 
ausgeprägter als bei kürzeren. Sie können 
die Effekte des Automation Drifting reduzieren, 
indem Sie mehrere kleine Clips erstellen, da sich 
der Startpunkt jedes darauf folgenden Clips ändert, 
wenn sich das Tempo ändert. 
Wenn das Tempo verlangsamt wird, erweitert sich 
die Automation. Wenn das Tempo erhöht wird, 
verkleinert sich die Automation.

Auf lange samplebasierte Audioclips auf einer 
tickbasierten Spur angewendeter Tempowechsel, 
Automation Drifting ist zu sehen

Tempo auf 146 BPM

Tempo auf 120 BPM
Kein Elastic Audio

Tickbasiert

Auf kurze samplebasierte Clips einer tickbasierten 
Spur angewendete Tempowechsel, minimales 
Automation Drifting ist zu sehen

Um einen Audioclip in kürzere Clips 
zu teilen, verwenden Sie Beat Detective. 
Weitere Informationen finden Sie unter 
Kapitel 30: „Beat Detective“.

Sie können Clips auch an Signalspitzen oder 
basierend auf der aktuellen Rasterauflösung 
trennen. Weitere Informationen finden Sie 
unter „Separate-Befehle“ auf Seite 600

Tempo auf 110 BPM

Kein Elastic Audio

Tickbasiert

Tempo auf 92 BPM



Pro Tools-Referenzhandbuch804

Tempowechsel und tickbasierte 
Elastic Audio-Spuren
Clips auf tickbasierten Elastic Audio-aktivierten 
Spuren wenden TCE (Time Compression and 
Expansion) basierend auf Tempowechseln an. 
Bei einfachen Tempowechseln passen sich Clips 
auf tickbasierten Elastic Audio-aktivierten Spuren 
automatisch an das neue Tempo an. Tempowechsel 
wirken sich nicht auf samplebasierte Elastic Audio-
aktivierte Spuren aus. 

In der folgenden Abbildung hat der erste 
zweitaktige Clip sein ursprüngliches Tempo 
von 120 BPM. Der zweite zweitaktige Clip wurde 
an den Tempowechsel auf 100 BPM angepasst. 
Da die Länge des zweiten Clips von zwei Takten 
bei dem langsameren Tempo per Warping 
beibehalten wurde, wird oben rechts in dem Clip 
die Clip Warp-Anzeige angezeigt.

Bei Tempokurven, wie einem Accelerando oder 
Ritardando, werden Tempo Event Warp-Marker 
automatisch entsprechend dem Tempo-Event 
erstellt und der Clip passt sich hieran an. 
Die folgende Abbildung zeigt einen Clip 
in der Warp-Darstellung. Beachten Sie, wie sich 
das Audiomaterial an die Tempokurve anpasst.

Über Tempo-Events erzeugte Warp-Marker 
können nicht bearbeitet werden. Sie zeigen nur an, 
wo ein Warping durchgeführt wurde, um das 
Audio an Tempowechsel anzupassen.

An Tempo angleichen
Mit Pro Tools können Sie Clips auf Elastic Audio-
aktivierten Spuren (sample- und tickbasiert) an das 
Tempo der Session anpassen. Mit dem Conform to 
Tempo-Befehl kann gegebenenfalls der selektierte 
Clip analysiert werden, um das Tempo und die 
Dauer (in Takten und Schlägen) zu ermitteln. 
Anschließend kann der Clip über die Elastic 
Audio-Verarbeitung an das Tempo der Session 
angepasst werden.

So passen Sie einen Clip an das Tempo der 
Session an:

1 Selektieren Sie den Clip, den Sie an das Tempo 
der Session anpassen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Conform to Tempo.

• Klicken Sie mit der rechten Maustaste auf den 
Clip, den Sie an das Tempo anpassen möchten, 
und wählen Sie Conform to Tempo.

An das Tempo angepasstes Audio, 
linearer Tempowechsel

An das Tempo angepasstes Audiomaterial, Tempokurve

Wenn Sie die Spur-Zeitbasis von Ticks 
zu Samples ändern, werden über Tempo-
Events erzeugte Warp-Marker in normale, 
bearbeitbare Warp-Marker konvertiert.
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Pro Tools untersucht die gesamte Datei des Clips 
auf Elastic Audio-Events und das Tempo. Wenn 
ein Tempo erkannt und eine Dauer in Takten und 
Schlägen bestimmt wurde, wird der Clip 
automatisch an das Tempo der Session angepasst. 
Wenn kein Tempo und keine Dauer bestimmt 
wurden (etwa bei einem aus einem Schlagzeugton 
bestehenden Clip oder bei einem langen Clip ohne 
eindeutiges Tempo), wird der Clip nicht an das 
Tempo der Session angepasst. 

Alternative Playlists und Tempo
Nur Tempoänderungen haben Auswirkungen 
auf alternative Playlists in Elastic Audio-fähigen, 
tickbasierten Spuren. Ansonsten werden alternative 
Playlists nicht durch die Bearbeitung von Warp- 
oder Event-Markern in der Haupt-Playlist 
beeinflusst.

Grafischer Tempo-Editor
Im Tempo-Editor, einem Fenster im Edit-Fenster 
unterhalb der Tempoleiste mit veränderbarer Größe, 
können Sie Tempoinformationen grafisch anzeigen 
und bearbeiten.

Anzeigen des Tempo-Editors 
Der Tempo-Editor ist eine Erweiterung 
der Tempoleiste, die im Leistenbereich 
des Edit-Fensters geöffnet wird. 

Sie haben folgende Möglichkeiten, den Tempo-
Editor anzuzeigen:

 Wählen Sie View > Rulers > Tempo und 
anschließend View > Rulers > Tempo > 

Tempo Editor.

 Klicken Sie im Tempo-Editor auf die 
Expand/Collapse-Schaltfläche.

Sie können auch das Teleskop-Warping in der 
Warp-Darstellung verwenden, um einen 
langen Clip manuell an das Tempo der 
Session anzupassen. Siehe „Teleskop-Warp“ 
auf Seite 920.

Es können nur Clips und keine Clipgruppen 
an das Tempo angepasst werden. 
Um Clipgruppen an das Tempo anzupassen, 
müssen Sie die Clipgruppierung aufheben, 
die Conform to Tempo-Funktion auf die 
zugrunde liegenden Clips anwenden und 
anschließend diese Clips wieder 
neu gruppieren.

Tempo Editor

Tempo Editor – Expand/Collapse-Schaltfläche
Tempoauflösung

Tempodichte
Tempowechsel hinzufügen

Tempo-Events
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Zoomen und Scrollen 
im Tempo-Editor 

So können Sie im Tempo-Editor 
vertikal heranzoomen:

 Klicken Sie auf die Schaltfläche „Tempo Editor 
Zoom In“ (+).

So können Sie im Tempo-Editor 
vertikal herauszoomen:

 Klicken Sie auf die Schaltfläche „Tempo Editor 
Zoom Out“ (–).

Sie haben folgende Möglichkeiten zum vertikalen 
Scrollen im Tempo-Editor:

 Klicken Sie auf den Bildlaufpfeil nach oben, 
um nach oben zu scrollen.

 Klicken Sie auf den Bildlaufpfeil nach unten, 
um nach unten zu scrollen.

 Ziehen Sie die Bildlaufleiste nach oben 
oder unten.

Bearbeiten von Tempo-
Events im Tempo-Editor
Tempo-Events können im Tempo-Editor 
folgendermaßen bearbeitet werden:

 Durch Ziehen mit einem der Grabber-Tools 
kann die Position bzw. der Wert jedes einzelnen 
Tempo-Events angepasst werden.

 Eine Gruppe ausgewählter Tempi kann mit dem 
Trim-Tool vergrößert oder verkleinert werden.

 Neue Tempo-Events können mit dem Pencil-
Tool eingezeichnet werden, um vorhandene 
Events zu ersetzen.

 Tempo-Events können kopiert und eingefügt 
sowie auf verschiedene Arten verschoben werden.

Zeichnen von Tempo-Events
Tempo-Events können im Tempo-Editor 
mit den folgenden Funktionen des Pencil-Tools 
gezeichnet werden.

Free Hand. – mit dieser Funktion können Sie eine 
Freihandzeichnung mit der Maus erstellen. 
Die Form wird in einer Reihe von Schritten 
entsprechend der Einstellung für „Tempo Edit 
Density“ erstellt. (Weitere Informationen dazu 
finden Sie unter „Auswählen der Tempo-
Bearbeitungsdichte“ auf Seite 807.)

Line. – mit dieser Funktion können Sie eine gerade 
Linie vom Drücken bis zum Loslassen der 
Maustaste zeichnen. Die Tempowerte werden 
schrittweise entsprechend den Einstellungen für 
„Tempo Edit Density“ und „Resolution“ geändert.

Parabolic. – diese Funktion zeichnet eine Kurve, die 
Ihrer Freihandzeichnung am nächsten kommt. Die 
Form wird in einer Reihe von Schritten entsprechend 
der Einstellung für „Tempo Edit Density“ erstellt.

S-Curve. – diese Funktion zeichnet eine S-Kurve, 
die Ihrer Freihandzeichnung am nächsten kommt. 
Die Form wird in einer Reihe von Schritten 
entsprechend der Einstellung für „Tempo 
Edit Density“ erstellt.

Zoom-Schaltflächen im Tempo-Editor

Die Pencil-Tool-Funktionen „Triangle“, 
„Square“ und „Random“ können nicht 
auf Tempo-Events angewendet werden.
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Selektieren der Tempo-
Auflösung (BPM-Rate) 
Im Tempo-Editor können Sie durch das Ändern 
der Tempo-Auflösung den BPM-Notenwert 
für Tempo-Events festlegen. Der für die Tempo-
Auflösung ausgewählte BPM-Notenwert basiert 
in der Regel auf der Taktart. Bei einem 4/4-Takt 
erfolgt der Schlag beispielsweise auf einer 
Viertelnote und bei einem 6/8-Takt (in der Regel) 
auf einer punktierten Viertelnote.

So wählen Sie die Tempoauflösung (BPM-Rate) 
für Pencil-Tool-Vorgänge:

 Klicken Sie auf den Tempo Resolution-Selektor 
und wählen Sie im Popup-Menü den geeigneten 
Notenwert. Die Tempoauflösung für mit dem 
Pencil-Tool gezeichnete Tempo-Events wird für 
die BPM-Rate auf den angegebenen Notenwert 
eingestellt.

 Klicken Sie auf den Tempo Resolution-Selektor 
und aktivieren Sie Follow Metronome Click. 
Die Tempoauflösung für mit dem Pencil-Tool 
gezeichnete Tempo-Events spiegelt 
automatisch die Metronomwerte wider, 
die durch Taktart-Events in der Meter-Leiste 
festgelegt sind. 

Bei Änderungen des Takts innerhalb 
des selektierten Bereichs kann eine Tempokurve 
verschiedene BPM-Werte aufweisen.

Auswählen der Tempo-
Bearbeitungsdichte
Im Tempo-Editor können Sie beim Zeichnen 
der Tempokurve mit dem Pencil-Tool die Dichte 
der Tempo-Events festlegen, die in der 
Tempoleiste erstellt werden.

Tempo Resolution-Selektor und Tempo Resolution-
Popup-Menü

Da das separate Einstellen von Taktart-Events 
für jedes Tempo-Event unnötig kompliziert sein 
kann, empfiehlt sich in den meisten Fällen das 
Aktivieren von „Follow Metronome Click“.

Tempokurve mit verschiedenen Metronomwerten

Tempo Edit Density-Selektor und Tempo Edit Density-
Popup-Menü

Viertelnoten-
Metronom-Klick

Metronom-Klick für 
punktierte Viertelnote
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So wählen Sie die Tempo Edit Density-Einstellung 
für alle Pencil-Tool-Vorgänge:

 Klicken Sie auf den Tempo Edit Density-
Selektor und wählen Sie im Popup-Menü einen 
Zeitwert. Mit dem Pencil-Tool gezeichnete 
Tempo-Events werden mit der eingestellten 
Dichte in die Tempoleiste eingefügt.

Kurvenanpassungsmodus
Nachdem Sie die neuen Tempi mit dem Pencil-
Tool gezeichnet haben, wird die Kurve blau 
angezeigt, um die neu erstellte Tempografik 
hervorzuheben. Mit den blauen 
Anpassungspunkten können Sie die Form und 
Größe der neuen Tempografik anpassen.

Die blauen Anpassungspunkte bleiben nur so 
lange aktiv, bis ein neues Tool ausgewählt oder ein 
neuer Befehl ausgeführt wird. 

Erstellen neuer 
Tempoeinstellungen mit 
Grabber-Tools
Mit den Grabber-Tools können Sie neue 
Tempoeinstellungen im Tempo-Editor durch 
Ziehen von Tempo-Events erstellen.

So ändern Sie das Tempo eines Tempo-Events:

 Ziehen Sie mit dem Grabber-Tool ein Tempo-
Event nach oben oder unten.

So ändern Sie die Position des Tempowechsels:

 Ziehen Sie mit dem Grabber-Tool ein Tempo-
Event nach links oder rechts.

So entfernen Sie ein Tempo-Event:

 Klicken Sie mit dem Grabber-Tool bei 
gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac) auf das Tempo-Event.

Durch Drücken der Windows-Taste 
(Windows) bzw. der ctrl-Taste (Mac) vor dem 
Zeichnen einer Linie mit dem Pencil-Tool 
werden keine neuen Tempo-Events erstellt, 
sondern bereits vorhandene an die 
gezeichnete Linie angepasst. 

Anpassungspunkte für die Tempokurve

Beim Ziehen der Anpassungspunkte werden 
alle neuen Tempo-Events unter der Kurve 
geändert. Wenn Sie die Kurvenform ändern 
möchten, ohne die Spurdaten sofort mit zu 
ändern, drücken Sie beim Anpassen der 
Kurve die Windows-Taste (Windows) bzw. 
die ctrl-Taste (Mac). Beim Loslassen der 
Maustaste werden die Tempo-Events an die 
neue Kurve angepasst.

Ändern eines Tempo-Events mit einem Grabber-Tool
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Selektieren von Tempo-Events
Es ist äußerst einfach, ein einzelnes Tempo-Event 
oder eine gesamte Tempokurve im Tempo-Editor 
zu selektieren.

So selektieren Sie ein Tempo-Event im 
Tempo-Editor:

 Doppelklicken Sie mit dem Selector-Tool oder 
einem Grabber-Tool zwischen zwei Tempo-
Events. Das erste Event wird ausgewählt.

So selektieren Sie eine Tempokurve 
im Tempo-Editor:

 Klicken Sie mit dem Selector-Tool oder 
einem Grabber-Tool dreimal auf die horizontale 
Tempolinie in der Kurve, die Sie auswählen 
möchten.

Erweitern von Temposelektionen
Temposelektionen können bis zum nächsten oder 
vorherigen Tempo-Event erweitert werden.

So erweitern Sie eine Temposelektion:

1 Wählen Sie mit dem Selector-Tool eine Reihe 
von Tempo-Events aus.

2 Sie haben folgende Möglichkeiten:

• Drücken Sie Umschalt + Tab, um die Selektion 
bis zum nächsten Tempo-Event zu erweitern.

• Drücken Sie Umschalt + Strg + Tab (Windows) 
bzw. Umschalt + Wahl +Tab (Mac), um die 
Selektion bis zum vorherigen Tempo-Event 
zu erweitern.

Skalieren und Strecken von 
Tempo-Events mit dem Trim-Tool
Mit dem Trim-Tool können Sie alle Tempo-Events 
der Session oder einer Timeline-Selektion 
skalieren. Sie können außerdem einen Clip mit 
Tempo-Events strecken, um einen längeren oder 
kürzeren Bereich in der Timeline abzudecken.

So skalieren Sie alle Tempo-Events der 
Session mit dem Trim-Tool:

1 Öffnen Sie den Tempo-Editor.

2 Klicken Sie mit dem Trim-Tool auf ein Tempo-
Event und ziehen Sie es nach oben oder unten. 
Durch Ziehen nach oben werden die Tempowerte 
aller Tempo-Events in BPM erhöht, durch Ziehen 
nach unten werden sie reduziert.

Selektieren eines einzelnen Tempo-Events

Selektieren einer Tempokurve

Ändern aller Tempo-Events mit dem Trim-Tool
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So skalieren Sie die selektierten Tempo-Events mit 
dem Trim-Tool:

1 Öffnen Sie den Tempo-Editor.

2 Selektieren Sie mit dem Selector-Tool den 
Bereich, den Sie bearbeiten möchten.

3 Klicken Sie mit dem Trim-Tool in den 
selektierten Bereich und ziehen Sie nach oben 
oder unten. Durch Ziehen nach oben werden die 
Tempowerte der Selektion in BPM erhöht, durch 
Ziehen nach unten werden sie reduziert.

So ändern Sie die Tempoänderungsrate für 
die absolute Zeit mit dem Trim-Tool:

1 Öffnen Sie den Tempo-Editor.

2 Selektieren Sie mit dem Selector-Tool den 
Bereich, den Sie bearbeiten möchten.

3 Klicken Sie mit dem Trim-Tool auf den 
Anpassungspunkt am Anfang oder am Ende 
des selektierten Bereichs und ziehen Sie ihn nach 
oben oder unten. Die BPM-Werte für Tempo-
Events werden entsprechend skaliert, und Tempo-
Events werden über eine längere oder kürzere 
Strecke der absoluten Zeit skaliert.

So skalieren Sie die Dauer von Tempoänderungen 
mit dem Trim-Tool:

1 Öffnen Sie den Tempo-Editor.

2 Selektieren Sie mit dem Selector-Tool den 
Bereich, den Sie bearbeiten möchten.

3 Klicken Sie mit dem Trim-Tool auf den Anfang 
oder das Ende der Selektion und ziehen 
Sie horizontal. Tempo-Events ändern sich nicht 
in Bezug auf die tatsächlichen BPM-Werte, 
sie werden jedoch über eine längere oder kürzere 
Strecke der absoluten Zeit skaliert.

Ändern der selektierten Tempo-Events mit dem 
Trim-Tool

Ändern der Tempoänderungsrate mit dem Trim-Tool

Skalieren der Dauer selektierter Tempo-Events 
mit dem Trim-Tool
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Ausschneiden, Einfügen und 
Verschieben (mit oder ohne 
Nudge-Funktion) im Tempo-Editor

So verschieben Sie ein Tempo-Event 
im Tempo-Editor (ohne Nudge-Funktion):

1 Öffnen Sie den Tempo-Editor.

2 Selektieren Sie mit dem Selector-Tool 
den Bereich, den Sie verschieben möchten.

3 Klicken Sie mit einem Grabber-Tool auf ein 
ausgewähltes Tempo-Event und ziehen 
Sie horizontal, um das Tempo-Event an eine 
neue Position zu verschieben. 

So kopieren Sie ein Tempo-Event im Tempo-Editor 
und fügen es anschließend ein:

1 Öffnen Sie den Tempo-Editor.

2 Selektieren Sie mit dem Selector-Tool den 
Bereich, den Sie kopieren möchten.

3 Wählen Sie Edit > Copy.

4 Klicken Sie im Tempo-Editor auf die Stelle, an 
der Sie die Tempo-Events einfügen möchten.

5 Wählen Sie Edit > Paste. Die kopierte 
Selektion wird am Einfügepunkt eingefügt; 
an dieser Stelle vorhandene Tempo-Events 
werden ersetzt.

So verschieben Sie eine Selektion 
im Tempo-Editor mit der Nudge-Funktion:

1 Öffnen Sie den Tempo-Editor.

2 Selektieren Sie mit dem Selector-Tool 
den Bereich, den Sie per Nudge-Funktion 
verschieben möchten.

3 Sie haben folgende Möglichkeiten:

• Drücken Sie die Plus-Taste (+) auf dem 
Ziffernblock, um die selektierten Tempo-Events 
um den Nudge-Wert nach rechts zu verschieben.

• Drücken Sie die Minus-Taste (–), um die Selektion 
um den Nudge-Wert nach links zu verschieben.

Ändern des Linearitäts-
Anzeigemodus
Die Timeline kann auf einer Linear Tick-Skala 
(relativ) oder auf einer Linear Sample-Skala 
(absolut) angezeigt werden. Abhängig von den 
Anzeigeeinstellungen der Zeitbasis verhalten sich 
MIDI- und Instrumentenspuren, Audiospuren und 
Tempokurven sehr unterschiedlich.

Das Linearity Display Mode-Popup-Menü 
bestimmt, ob Tempo-Events im Tempo-Editor in 
einer absoluten (Samples) oder relativen (Ticks) 
Zeitbasis angezeigt werden.

Linear Sample Display. – die Timeline wird 
samplebasiert angezeigt und die Position 
tickbasierter Events (wie Takte und Schläge) ändert 
sich nach dem Zeichnen einer Tempokurve. 

Um eine Kopie der Tempo-Events 
zu verschieben, halten Sie beim Ziehen 
die Alt-Taste (Windows) bzw. 
die Wahltaste (Mac) gedrückt.

Linearity Display Mode-Selektor und Linearity Display 
Mode-Popup-Menü
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Bei einem Tempowechsel ändert sich damit die 
Position von Takten und Schlägen gegenüber 
der festen samplebasierten Timeline 
(wie „Minutes:Seconds“). Vergewissern Sie sich 
bei der Verwendung von samplebasiertem 
Material, etwa beim Tracking oder Mischen, dass 
„Linear Sample Display“ ausgewählt ist. Dies ist 
besonders wichtig, wenn Sie die Tempo- und 
Taktart-Map an samplebasierten Events ausrichten 
möchten.

Linear Tick Display. – Tempo-Events werden 
tickbasiert angezeigt, die Bar|Beat-Positionen der 
Tempo-Events bleiben nach dem Zeichnen der 
Tempokurve unverändert und alle samplebasierten 
Events werden gegenüber den Bar|Beat-Positionen in 
der Timeline verschoben. Vergewissern Sie sich bei 
der Verwendung von tickbasiertem Material, 
wie MIDI-Noten oder Elastic Audio-Events, dass 
„Linear Tick Display“ ausgewählt ist. 
Dies ist besonders wichtig, wenn Sie Tempowechsel 
vornehmen, die Takte und Schläge in der Timeline 
jedoch unverändert bleiben sollen.

So ändern Sie die Zeitbasis-Anzeige:

 Klicken Sie auf den Linearity Display Mode-
Selektor und wählen Sie aus dem Popup-Menü 
eine Zeitbasis aus.

„Tempo Edit Density“ und 
„Linearity Display Mode“
Wenn die Tempo Edit Density-Einstellung 
(im Tempo-Editor) und die Linearity Display 
Mode-Einstellung auf eine Bars|Beats-Zeitskala 
oder eine absolute Zeitskala gesetzt sind, 

werden Tempobearbeitungen gleichmäßig verteilt 
angezeigt. Ist allerdings eine der beiden 
Einstellungen auf eine Bars|Beats-Zeitskala und 
die andere auf eine absolute Zeitskala gesetzt, 
scheint die Anzahl der Tempobearbeitungen über 
den Zeitverlauf hinweg entweder zu- oder 
abzunehmen (im Hinblick auf die absolute Zeit).

Tempo Operations Window
Im Tempo Operations-Fenster können Sie Tempo-
Events definieren, die auf einen Zeitraum (oder eine 
Reihe von Takten) angewendet werden. 
Der Zeitraum wird in dem derzeit in der Haupt-
Zeitskala aktiven Zeitformat angegeben. Darüber 
hinaus können Sie im Tempo Operations-Fenster 
Folgendes ausführen:

• Eine bestimmte Anzahl von Bars|Beats in einen 
genau definierten Zeitraum einpassen

• Tempi erstellen, die entweder linear oder nach 
verschiedenen Kurvenverläufen beschleunigt 
oder verlangsamt werden

• Bestehende Tempi skalieren oder strecken

Das Tempo Operations-Fenster verfügt über sechs 
Seiten, eine für jeden Typ von Tempovorgängen.

Constant. – hier können Sie ein konstantes Tempo 
für einen ausgewählten Zeitraum einstellen.

Linear. – hier können Sie Tempi erstellen, die sich 
über einen ausgewählten Zeitraum hinweg 
gleichmäßig ändern.

Parabolic. – hier können Sie Tempi erstellen, 
die anhand einer Tempokurve beschleunigt oder 
verlangsamt werden, wobei das Tempo über den 
Selektionszeitraum hinweg unterschiedlich 
schnell beschleunigt wird.

Wenn Sie Tempo-Events mithilfe von „Linear 
Tick Display“ zeichnen, wird Bar|Beat-
basiertes Material verschoben. Dies kann 
die Verwendung von tickbasiertem Material 
erschweren. In den meisten Fällen sollten 
Sie daher beim Zeichnen von Tempowechseln 
„Linear Sample Display“ verwenden.

Das Tempo Operations-Fenster ist im 
Manual Tempo-Modus nicht verfügbar.
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S-Curve. – hier können Sie Tempi erstellen, 
die anhand einer Tempokurve beschleunigt oder 
verlangsamt werden. Die Tempokurve enthält 
definierbare Breakpoints, mit deren Hilfe 
die Zeiten und Tempowerte in der Mitte der Kurve 
bestimmt werden.

Scale. – hier können Sie Tempi in der Selektion 
durch Angabe eines Prozentsatzes skalieren. 

Stretch. – hier können Sie einen Clip mit Tempo-
Events selektieren und diesen auf einen größeren 
oder kleineren Bereich anwenden.

So öffnen Sie eine bestimmte Seite im Tempo 
Operations-Fenster:

 Wählen Sie Event > Tempo Operations und 
danach einen der Tempo Operations-Befehle 
(etwa Constant).

So öffnen Sie die letzte aktive Seite des 
Tempo Operations-Fensters:

 Wählen Sie Event > Tempo > Tempo 

Operations Window.

So definieren Sie Tempo-Events über einen Zeitraum:

1 Nehmen Sie eine Selektion in der Zeitbasis oder 
einer Spur vor.

2 Wählen Sie Event > Tempo > Tempo 

Operations Window.

3 Wählen Sie aus dem Popup-Menü im Tempo 
Operations-Fenster eine Tempo Operations-Seite.

4 Ändern Sie die Einstellungen der gewählten 
Seite wie erforderlich.

5 Sie haben folgende Möglichkeiten:

• Klicken Sie auf Apply.

• Drücken Sie Eingabe (Windows) bzw. 
Return (Mac), um die Werte automatisch 
zu übernehmen und das Fenster zu schließen.

Constant
Auf der Constant-Seite des Tempo Operations-
Fensters können Sie ein konstantes Tempo 
für einen selektierten Zeitraum einstellen.

Advanced. – wenn diese Option selektiert ist, 
übernimmt der Selektionsbereich das Format der 
Haupt-Zeitskala, wodurch zusätzliche Optionen 
verfügbar werden.

Calculate (Advanced-Option). – berechnet das 
Tempo oder die Endzeit der Selektion.

Selection Start/End. – geben den Start- bzw. 
Endpunkt der Tempoänderung in Bars|Beats 
an. Im Falle einer Edit-Selektion zeigen Start- und 
End-Feld die Selektionsgrenzen an.

Wenn das Tempo Operations-Fenster bereits 
geöffnet ist, können Sie über das Popup-
Menü oben im Fenster die gewünschte Seite 
ansteuern.

Drücken Sie Alt + 2 (Windows) bzw. Wahl + 2 
(Mac) auf dem Ziffernblock, um das Tempo 
Operations-Fenster mit der zuletzt angezeigten 
Tempo Operations-Seite zu öffnen.

Constant-Seite (Advanced-Option)
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End Time (Advanced-Option). – zeigt den 
Endzeitpunkt der Selektion an. Wenn die Haupt-
Zeitskala auf „Bars|Beats“ gesetzt ist, wird der 
Endzeitpunkt in der Sub-Zeitskala angezeigt. 
Bei einer absoluten Zeitbasis in der Haupt-
Zeitskala wird der Endzeitpunkt berechnet und in 
Bars|Beats angezeigt. Durch Ändern 
des Endzeitpunkts ändern Sie auch das Tempo.

Tempo. – gibt das Tempo des Selektionsbereichs 
in BPM (Beats per Minute) an.

Resolution (Advanced-Option). – hier können 
Sie den BPM-Notenwert für Ihre 
Tempoeinstellung wählen.

Density (Advanced-Option). – hier können 
Sie die Dichte der Tempoänderungen 
in der Tempoleiste angeben.

Preserve Tempo after Selection. – wenn diese 
Option aktiviert ist, wird die vor dem Endpunkt 
der Selektion gültige Tempoeinstellung beibehalten. 
Wenn sie nicht aktiviert ist, bleibt das letzte 
vom Tempovorgang erstellte Tempo-Event 
bis zum Session-Ende oder zum nächsten Tempo-
Event außerhalb des Selektionsbereichs gültig.

Linear
Auf der Linear-Seite des Tempo Operations-
Fensters können Sie Tempi erstellen, die sich 
über einen selektierten Zeitraum hinweg 
gleichmäßig ändern.

Advanced. – wenn diese Option selektiert ist, 
übernimmt der Selektionsbereich das Format der 
Haupt-Zeitskala, wodurch zusätzliche Optionen 
verfügbar werden.

Calculate (Advanced-Option). – berechnet 
die Endzeit der Selektion, das Start- oder 
das Endtempo.

Selection Start/End . – zeigen den Start- und 
Endpunkt der Tempoänderung in der derzeit 
ausgewählten Main-Zeitbasis an. Im Falle 
einer Edit-Selektion zeigen Start- und End-Feld 
die Selektionsgrenzen an. Durch Änderung des 
Start- bzw. Endwerts ändert sich auch der 
Selektionsbereich.

End Time (Advanced-Option). – zeigt die absolute 
Zeit des Selektionsendes an. Wenn die Haupt-
Zeitskala auf „Bars|Beats“ gesetzt ist, wird der 
Endzeitpunkt in der Sub-Zeitskala angezeigt. 
Bei einer absoluten Zeitbasis in der Haupt-Zeitskala 
wird der Endzeitpunkt berechnet und in Bars|Beats 
angezeigt. Durch Ändern des Endzeitpunkts ändern 
Sie auch das Tempo.

Tempo Start/End. – zeigt das Tempo für Start- und 
Endpunkt des Selektionsbereichs in BPM 
(Beats per Minute) an. Durch Ändern des Tempos 
ändern Sie auch den Endzeitpunkt.

Durch Auswahl von „Follow Metronome 
Click“ übernimmt der BPM-Notenwert für 
das Tempo den Wert des Metronoms in den 
Meter-Markern.

Linear-Seite (Advanced-Option)
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Resolution (Advanced-Option). – hier können 
Sie den BPM-Notenwert für Ihre 
Tempoeinstellung wählen.

Density (Advanced-Option). – hier können 
Sie die Dichte der Tempoänderungen in der 
Tempoleiste angeben.

Preserve Tempo after Selection. – wenn diese 
Option aktiviert ist, wird die vor dem Endpunkt der 
Selektion gültige Tempoeinstellung beibehalten. 
Wenn sie nicht aktiviert ist, bleibt das letzte vom 
Tempovorgang erstellte Tempo-Event bis zum 
Session-Ende oder zum nächsten Tempo-Event 
außerhalb des Selektionsbereichs gültig.

Parabolic
Auf der Parabolic-Seite des Tempo Operations-
Fensters können Sie Tempi erstellen, die anhand 
einer Tempokurve beschleunigt oder verlangsamt 
werden, sodass das Tempo über 
den Selektionszeitraum hinweg unterschiedlich 
schnell geändert wird.

Advanced. – wenn diese Option selektiert ist, 
übernimmt der Selektionsbereich das Format der 
Haupt-Zeitskala, wodurch zusätzliche Optionen 
verfügbar werden.

Calculate (Advanced-Option). – berechnet die 
Endzeit der Selektion, das Start- oder Endtempo 
oder den Kurvenverlauf des Tempowechsels. 

Selection Start/End. – zeigen den Start- und 
Endpunkt der Tempoänderung in der derzeit 
ausgewählten Main-Zeitbasis an. Im Falle einer 
Edit-Selektion zeigen Start- und End-Feld die 
Selektionsgrenzen an. Durch Änderung des 
Start- bzw. Endwerts ändert sich auch der 
Selektionsbereich.

End Time (Advanced-Option). – zeigt die absolute 
Zeit des Selektionsendes an. Wenn die Haupt-
Zeitskala auf „Bars|Beats“ gesetzt ist, wird 
der Endzeitpunkt in der Sub-Zeitskala angezeigt. 
Bei einer absoluten Zeitbasis in der Haupt-Zeitskala 
wird der Endzeitpunkt berechnet und in Bars|Beats 
angezeigt. Durch Ändern des Endzeitpunkts ändern 
Sie auch das Tempo.

Tempo Start/End. – zeigt das Tempo für Start- und 
Endpunkt des Selektionsbereichs in BPM (Beats 
per Minute) an. Durch Ändern des Tempos ändern 
Sie auch den Endzeitpunkt.

Curvature. – definiert eine numerische und 
grafische Darstellung der Tempokurve und zeigt 
sie an. Negative Zahlen geben einen schnelleren 
Tempowechsel am Anfang des Zeitraums an, 
während positive Zahlen einen schnelleren 
Tempowechsel am Ende des Zeitraums festlegen. 
Dieser Wert kann mit dem Curvature-
Schieberegler eingestellt werden.

Resolution (Advanced-Option). – hier können 
Sie den BPM-Notenwert für Ihre 
Tempoeinstellung wählen.

Durch Auswahl von „Follow Metronome Click“ 
übernimmt der BPM-Notenwert für das Tempo 
den Wert des Metronoms in den Meter-Markern.

Parabolic-Seite (Advanced-Option)

Durch Auswahl von „Follow Metronome Click“ 
übernimmt der BPM-Notenwert für das Tempo 
den Wert des Metronoms in den Meter-Markern.
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Density (Advanced-Option). – hier können 
Sie die Dichte der Tempoänderungen 
in der Tempoleiste angeben.

Preserve Tempo after Selection. – wenn diese 
Option aktiviert ist, wird die vor dem Endpunkt 
der Selektion gültige Tempoeinstellung beibehalten. 
Wenn sie nicht aktiviert ist, bleibt das letzte 
vom Tempovorgang erstellte Tempo-Event bis zum 
Session-Ende oder zum nächsten Tempo-Event 
außerhalb des Selektionsbereichs gültig.

S-Curve
Auf der S-Curve-Seite des Tempo Operations-
Fensters können Sie Tempi erstellen, die anhand 
einer Tempokurve beschleunigt oder verlangsamt 
werden. Die Tempokurve enthält definierbare 
Breakpoints, mit deren Hilfe die Zeit- 
und Tempowerte in der Mitte der Kurve 
bestimmt werden.

Advanced. – wenn diese Option selektiert ist, 
übernimmt der Selektionsbereich das Format der 
Haupt-Zeitskala, wodurch zusätzliche Optionen 
verfügbar werden. 

Calculate (Advanced-Option). – berechnet die 
Endzeit der Selektion, das Start- oder Endtempo 
oder den Kurvenverlauf des Tempowechsels. 

Selection Start/End. – zeigen den Start- und 
Endpunkt der Tempoänderung in der derzeit 
ausgewählten Main-Zeitbasis an. Im Falle 
einer Edit-Selektion zeigen Start- und End-Feld 
die Selektionsgrenzen an. Durch Änderung 
des Start- bzw. Endwerts ändert sich auch 
der Selektionsbereich.

Start and End Time (Advanced-Option). – zeigt 
die absolute Zeit des Selektionsendes an. 
Wenn die Haupt-Zeitskala auf „Bars|Beats“ 
gesetzt ist, wird der Endzeitpunkt in der Sub-
Zeitskala angezeigt. Bei einer absoluten Zeitbasis 
in der Haupt-Zeitskala wird der Endzeitpunkt 
berechnet und in Bars|Beats angezeigt.

Tempo Start/End. – zeigt das Tempo für Start- und 
Endpunkt des Selektionsbereichs in BPM 
(Beats per Minute) an. Durch Ändern des Tempos 
ändern Sie auch den Endzeitpunkt.

Curvature. – definiert eine numerische und grafische 
Darstellung der Tempokurve und zeigt sie an. 
Negative Zahlen geben einen schnelleren 
Tempowechsel am Anfang und Ende des Zeitraums 
mit einer geringen Änderungsrate rund um den 
Mittelpunkt an. Positive Zahlen stehen für eine 
geringe Änderungsrate am Anfang und Ende des 
Zeitraums, mit einem schnelleren Tempowechsel 
rund um den Mittelpunkt. Dieser Wert kann mit dem 
Curvature-Schieberegler eingestellt werden.

Mid Point. – gibt die Haupt-Zeitskala-Position des 
Kurvenmittelpunkts an. Dieser Wert kann mit dem 
Mid Point-Schieberegler eingestellt werden.

S-Curve-Seite (Advanced-Option)
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Mid Tempo. – gibt das Tempo am Mittelpunkt 
an. Dieser Wert kann mit dem Mid Tempo-
Schieberegler eingestellt werden.

Resolution (Advanced-Option). – hier können 
Sie den BPM-Notenwert für Ihre 
Tempoeinstellung wählen.

Density (Advanced-Option). – hier können 
Sie die Dichte der Tempoänderungen 
in der Tempoleiste angeben.

Preserve Tempo after Selection. – wenn diese 
Option aktiviert ist, wird die vor dem Endpunkt 
der Selektion gültige Tempoeinstellung beibehalten. 
Wenn sie nicht aktiviert ist, bleibt das letzte vom 
Tempovorgang erstellte Tempo-Event bis zum 
Session-Ende oder zum nächsten Tempo-Event 
außerhalb des Selektionsbereichs gültig.

Scale
Auf der Scale-Seite des Tempo Operations-
Fensters können Sie Tempi in der Selektion durch 
Angabe eines Prozentsatzes skalieren.

Advanced. – wenn diese Option selektiert ist, 
übernimmt der Selektionsbereich das Format der 
Haupt-Zeitskala, wodurch zusätzliche Optionen 
verfügbar werden.

Calculate (Advanced-Option). – neben den 
im Scale-Popup-Menü ausgewählten Einstellungen 
können Sie im Calculate-Popup-Menü die Endzeit 
der Selektion, das Durchschnittstempo und das Start- 
oder Endtempo berechnen. 

Scale (Advanced-Option). – neben den im 
Calculate-Popup-Menü ausgewählten Einstellungen 
können Sie im Scale-Popup-Menü alle Tempi, 
das Start- oder das Endtempo skalieren.

Wenn Sie alle Tempi skalieren, wird jedes Tempo 
im selektierten Bereich gleichermaßen skaliert. Wenn 
Sie das Starttempo skalieren, werden die Tempi 
ungleichmäßig skaliert: Das erste Tempo wird am 
stärksten skaliert, alle darauf folgenden Tempo-
Events immer schwächer, bis zum Endtempo, das gar 
nicht skaliert wird. Wenn Sie das Endtempo skalieren, 
werden die Tempi ungleichmäßig skaliert: Das letzte 
Tempo wird am stärksten skaliert, alle vorherigen 
Tempo-Events immer schwächer, bis zum 
Starttempo, das gar nicht skaliert wird.

Selection Start/End. – zeigen den Start- und 
Endpunkt des Tempovorgangs in der derzeit 
ausgewählten Main-Zeitbasis an. Im Falle einer 
Edit-Selektion zeigen Start- und End-Feld 
die Selektionsgrenzen an. Durch Änderung 
des Start- bzw. Endwerts ändert sich auch 
der Selektionsbereich.

Start and End Time. – zeigt die absolute Zeit des 
Selektionsstart- und -endpunkts an. Wenn die 
Haupt-Zeitskala auf „Bars|Beats“ gesetzt ist, 
werden die Zeiten in der Sub-Zeitskala angezeigt. 
Bei einer absoluten Zeitbasis in der Haupt-
Zeitskala werden die Zeiten berechnet und in 
Bars|Beats angezeigt.

Durch Auswahl von „Follow Metronome 
Click“ übernimmt der BPM-Notenwert für 
das Tempo den Wert des Metronoms in den 
Meter-Markern.

Scale-Seite (Advanced-Option)
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Average Tempo. – zeigt das Durchschnittstempo 
des Selektionsbereichs in BPM (Beats per Minute) 
an. Durch Ändern des Durchschnittstempos 
ändern Sie auch den Skalierungsprozentsatz.

Scale. – zeigt den Prozentsatz an, durch den das 
Tempo, in BPM (Beats per Minute)¸ 
im Selektionsbereich skaliert ist. Durch Ändern 
von „Scale“ ändern Sie auch „Average Tempo“

Preserve Tempo after Selection. – wenn diese 
Option aktiviert ist, wird die vor dem Endpunkt 
der Selektion gültige Tempoeinstellung beibehalten. 
Wenn sie nicht aktiviert ist, bleibt das letzte vom 
Tempovorgang erstellte Tempo-Event bis zum 
Session-Ende oder zum nächsten Tempo-Event 
außerhalb des Selektionsbereichs gültig.

Stretch
Auf der Stretch-Seite des Tempo Operations-
Fensters können Sie einen Clip mit Tempo-Events 
selektieren und diesen auf einen größeren oder 
kleineren Bereich anwenden.

Advanced. – wenn diese Option selektiert ist, 
übernimmt der Selektionsbereich das Format 
der Haupt-Zeitskala, wodurch zusätzliche 
Optionen verfügbar werden.

Selection Start/End. – gibt die Reihe der Tempo-
Events an, die Sie bearbeiten möchten. Im Falle 
einer Edit-Selektion zeigen Start- und End-Feld 
die Selektionsgrenzen an. 

Stretch To End. – bestimmt einen neuen Endpunkt 
für den Clip, auf den Sie die selektierten Tempo-
Events anwenden möchten. Durch Ändern 
des Endpunkts ändern Sie auch den 
Stretch-Prozentsatz.

Stretch To Start (Advanced-Option). – bestimmt 
einen neuen Startpunkt für den Clip, auf den 
Sie die selektierten Tempo-Events anwenden 
möchten. Durch Ändern des Endpunkts ändern Sie 
auch den Stretch-Prozentsatz.

Stretch. – gibt den Prozentsatz der Zeit an, den die 
selektierten Tempo-Events ausfüllen sollen.

Preserve Tempo after Selection. – wenn diese 
Option aktiviert ist, wird die vor dem Endpunkt 
der Selektion gültige Tempoeinstellung beibehalten. 
Wenn sie nicht aktiviert ist, bleibt das letzte 
vom Tempovorgang erstellte Tempo-Event bis zum 
Session-Ende oder zum nächsten Tempo-Event 
außerhalb des Selektionsbereichs gültig.

Identify Beat-Befehl 
Mit dem Identify Beat-Befehl können Sie eine 
Tempo- bzw. Taktart-Map erstellen, wenn das 
Audiomaterial ohne Metronom-Klick aufgenommen 
wurde oder wenn Sie Audiomaterial importieren 
wollen, dessen Tempo nicht bekannt ist.

Mit dem Identify Beat-Befehl können Sie einen 
selektierten Bereich (der in der Regel eine bestimmte 
Anzahl von Schlägen oder Takten umfasst) analysieren 
und sein Tempo auf der Grundlage der eingestellten 
Taktart berechnen. Dabei werden Bar|Beat-Marker für 
das berechnete Tempo eingefügt und erscheinen in der 
Tempoleiste am Anfang und Ende der Selektion. 
Außerdem werden Taktart-Events in der Meter-Leiste 
eingefügt.

Stretch-Seite (Advanced-Option)

Sie können Beat Detective verwenden, 
um Bar|Beat-Marker innerhalb einer 
Selektion zu erzeugen, die auf Beats oder 
Sub-Beats rhythmische Abweichungen 
enthält (siehe Kapitel 30: „Beat Detective“).
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Bar|Beat-Marker
Bar|Beat-Marker ähneln Tempo-Events zwar im 
Aussehen, doch wird ihre Position durch ein 
kleines blaues Dreieck gekennzeichnet.

Wählen von Bar|Beat-Markern 
oder Tempo-Events
Da Tempo-Events tickbasiert und Bar|Beat-
Marker samplebasiert sind, können sie nicht 
gemischt werden. Wenn eine Session Tempo-
Events enthält und Sie einen Bar|Beat-Marker 
einfügen möchten, werden bereits vorhandene 
Tempo-Events in Bar|Beat-Marker konvertiert 
(und umgekehrt).

Sie können Tempo-Events außerdem manuell 
in Bar|Beat-Marker konvertieren und umgekehrt. 
Bei der Konvertierung zwischen Tempo-Events 
und Bar|Beat-Markern können Sample-Rundungen 
auftreten.

So verwenden Sie Tempo-Events oder 
Bar|Beat-Marker:

1 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf die 
Add Tempo Change-Schaltfläche.

2 Wählen Sie im Popup-Menü entweder Tempo 

Events oder Bar|Beat Markers. 

Identifizieren von Schlägen

So identifizieren Sie den Beat eines eintaktigen 
Schlagzeug-Loops und erstellen dafür 
Bar|Beat-Marker:

1 Positionieren Sie einen eintaktigen Schlagzeug-
Loop am Anfang einer Audiospur.

2 Aktivieren Sie View > Rulers > Samples. Damit 
wird sichergestellt, dass die Selektion des 
Audiomaterials samplegenau erfolgen kann.

3 Selektieren Sie mit dem Time Grabber-
Tool einen Audioclip und wählen Sie 
Event > Identify Beat.

4 Geben Sie im Bar|Beat Markers-Dialogfeld einen 
Wert für die Start- und Endposition für die 
einzufügenden Bar|Beat-Marker ein. Für den 
in diesem Beispiel verwendeten eintaktigen Loop 
müssten Sie also den Startpunkt 1|1|000 und den 
Endpunkt 2|1|000 eingeben.

Bar|Beat-Marker

Tempo Ruler-Popup-Menü

Identify Beat-Dialogfeld
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5 Falls notwendig, geben Sie für den Start- und 
Endbereich eine Taktart (Time Signature) ein.

6 Klicken Sie auf OK, damit das neue 
Tempo automatisch berechnet wird und 
die entsprechenden Bar|Beat-Marker 
sowie Taktart-Events eingefügt werden. 
Sämtliche bereits vorhandenen Tempo- 
und Taktart-Events innerhalb der 
Selektion werden gelöscht.

Wenn Sie mit einer Selektion arbeiten, wird durch 
den Identify Beat-Befehl jeweils nur ein Tempo 
für den selektierten Bereich berechnet. Wenn sich 
das Tempo von Takt zu Takt oder gar von Schlag zu 
Schlag ändert, müssen Sie den Identify Beat-Befehl 
für jeden Bereich mit unterschiedlichem Tempo 
einzeln anwenden. Achten Sie dabei darauf, die 
selektierten Bereiche sowie die Schlag-Position des 
Tempowechsels möglichst genau festzulegen.

Um die exakte Tempoanalyse eines Audiobereichs 
mithilfe des Identify Beat-Befehls zu definieren, 
stellen Sie sicher, dass die Länge der anfänglichen 
Selektion möglichst genau der Länge der 
Zeiteinheiten für Takte und Schläge entspricht. Dazu 
können Sie die Selektion zunächst als Loop 
wiedergeben, um eine präzise Wiedergabe 
sicherzustellen (siehe „Loop Playback-Modus“ auf 
Seite 418). Um Abweichungen zu vermeiden und die 
Samplegenauigkeit zu erhalten, sollte die Zeitskala 
bei der Selektion des Audiomaterials auf Samples 
und nicht auf Bars|Beats eingestellt sein.

Ziehen von Bar|Beat-Markern
Wenn Sie einen Audioclip neu positioniert haben 
oder einen Bar|Beat-Marker innerhalb eines 
Audioclips an den Takt anpassen möchten, können 
Sie den Bar|Beat-Marker jederzeit durch Ziehen an 
eine neue Position verschieben. Die benachbarten 
MIDI-Daten werden dabei automatisch an die 
neue Tempo-Map angepasst.

Da Bar|Beat-Marker samplebasiert und Tempo-
Events tickbasiert sind, verhalten sie sich beim 
Verschieben in der Tempoleiste unterschiedlich.

Das Verschieben eines Bar|Beat-Markers wirkt 
sich folgendermaßen aus:

• Der dazugehörige BPM-Wert wird zusammen 
mit dem nächstgelegenen Bar|Beat-Marker links 
daneben neu berechnet. Bar|Beat-Marker rechts 
des verschobenen Markers bleiben unverändert.

• Die Taktposition wird mit dem Bar|Beat-Marker 
verschoben. Wenn der Bar|Beat-Marker 
beispielsweise ursprünglich auf der Position 
3|1|000 platziert war, so bleibt er auch auf dieser 
Taktposition (sofern diese Position nicht 
bearbeitet wird).

• Die dazugehörige Sample- und SMPTE-
Position ändert sich entsprechend 
dem neu berechneten Tempo.

Eingefügte Bar|Beat-Marker

Wählen Sie beim Identifizieren von Beats 
einen möglichst großen Bereich. Beispiel: 
Wenn Sie bei einer vier Takte lange 
Audiodatei die Beats identifizieren möchten, 
selektieren Sie nicht nur einen, sondern alle 
vier Takte, um Rundungsfehler zu verringern 
(siehe „Sample-Rundungen und 
Editiervorgänge“ auf Seite 798).



Kapitel 35: Zeit, Tempo, Taktart, Tonart und Akkorde 821

• Benachbarte MIDI-Events und die Bars|Beats-
Leiste werden entsprechend verkürzt bzw. 
verlängert und an das neue Tempo angepasst.

Das Verschieben eines Tempo-Events wirkt 
sich folgendermaßen aus:

• Das Tempo-Event wird an einer neuen 
Taktposition platziert. Sample- und 
SMPTE-Position für das Event werden ebenfalls 
aktualisiert.

• Der BPM-Wert für das verschobene Tempo-
Event bleibt ebenso wie für alle anderen Tempo-
Events der Session unverändert.

• Benachbarte MIDI-Events und Audioclips 
auf tickbasierten Spuren sowie die Leiste 
werden entsprechend verkürzt bzw. verlängert 
und an die neue Tempo-Position angepasst.

Bearbeiten von 
Bar|Beat-Markern
Auch die Taktposition eines Bar|Beat-Markers kann 
bearbeitet werden. Dadurch wird der Start- oder 
Endpunkt des Bereichs, dessen Tempo analysiert 
wurde, ebenfalls geändert. Es besteht also 
ein Unterschied zwischen dem Verschieben und dem 
Bearbeiten eines Bar|Beat-Markers. 

So bearbeiten Sie einen Bar|Beat-Marker:

1 Doppelklicken Sie in der Tempoleiste 
auf den Bar|Beat-Marker.

2 Geben Sie im Edit Bar|Beat-Dialogfeld eine 
neue Position für den Bar|Beat-Marker ein.

3 Geben Sie eine neue Taktart ein. 

4 Klicken Sie auf OK.

So löschen Sie einen Bar|Beat-Marker:

 Klicken Sie mit dem Grabber-Tool bei 
gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac) auf den Bar|Beat-Marker.

Einfügen einzelner 
Bar|Beat-Marker
Samplebasiertes Audiomaterial mit 
Temposchwankungen

Sie können einzelne Bar|Beat-Marker einfügen, 
indem Sie einen Edit-Einfügepunkt setzen 
(anstatt eine Selektion zu treffen), bevor Sie 
den Identify Beat-Befehl verwenden. Jeden Schlag 
einzeln identifizieren zu können ist besonders dann 
hilfreich, wenn Sie samplebasiertes Audiomaterial 
bearbeiten, das Temposchwankungen aufweist.

Bei einem Takt mit einer leichten Beschleunigung 
des Tempos können Sie beispielsweise auf jedem 
Schlag einen Bar|Beat-Marker einfügen, sodass das 
Tempo präzise wiedergegeben wird.

Sie können Anpassungen in der Tempo-Map auch 
noch durchführen, nachdem Sie Bar|Beat-Marker 
eingefügt haben. Verschieben Sie die einzelnen 
Marker dazu ggf. so, dass sie dem Takt des 
Audiomaterials exakt entsprechen.

Ziehen eines Bar|Beat-Markers

Edit Bar|Beat-Dialogfeld

Bar|Beat-Marker auf jedem Schlag
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Taktart-Events
Sie können die Taktart in der Meter-Leiste ändern 
oder präzise Taktartänderungen im Time Operations-
Fenster vornehmen.

Sie können Taktart-Events am Anfang einer Session 
einfügen, um die voreingestellte Taktart (4/4) zu 
ersetzen, oder an jeder anderen beliebigen Position in 
der Session, um die Taktart zu ändern.

So zeigen Sie die Meter-Leiste an:

 Aktivieren Sie View > Rulers > Meter.

Aktuelle Taktart
Die aktuelle Taktart der Session wird während der 
Wiedergabe im Transport-Fenster angezeigt und 
hängt vom jeweils letzten Taktart-Event ab.

Einfügen von Taktart-Events

So fügen Sie ein Taktart-Event ein:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Event > Time Operations > 

Change Meter.

• Klicken Sie auf die Add Meter Change-
Schaltfläche rechts von der Meter-Leiste.

• Klicken Sie bei gedrückter Windows-Taste 
(Windows) bzw. ctrl-Taste (Mac) mit dem 
Grabber-Tool auf die Position, an der Sie das 
Event einfügen möchten.

• Doppelklicken Sie im Transport-Fenster auf die 
Meter-Anzeige.

2 Geben Sie im Meter Change-Fenster Position 
und Taktart für die Taktartänderung ein.

3 Wenn Sie das eingefügte Taktart-Event genau 
auf dem ersten Schlag des nächstgelegenen 
Takts positionieren möchten, wählen Sie 
Snap To Bar.Anzeige der aktuellen Taktart im Transport-Fenster

Add Meter Change-Schaltfläche

Manuelles Einfügen eines Taktart-Events

Anzeige der aktuellen Taktart im Transport-Fenster

Meter Change-Fenster
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4 Wählen Sie einen Notenwert für die Anzahl 
der Metronom-Klicks pro Takt. Wenn Sie 
punktierte Notenwerte benötigen, wählen 
Sie das Punktsymbol (.).

5 Klicken Sie auf OK, um das neue Taktart-Event 
einzufügen. Das neue Taktart-Event wird 
eingefügt und erscheint nun in der Meter-Leiste.

Die Position eines jeden Taktart-Events wird durch ein 
kleines gelbes Dreieck angezeigt. Das Dreieck kann 
zum Kopieren und Einfügen ausgewählt werden. 
Durch Doppelklicken auf ein solches Dreieck kann 
das Taktart-Event bearbeitet werden.

Bearbeiten von Taktart-Events
Vorhandene Taktart-Events können bearbeitet, 
gelöscht, kopiert und eingefügt werden.

So bearbeiten Sie ein Taktart-Event:

1 Doppelklicken Sie in der Meter-Leiste auf das 
Taktart-Event.

2 Geben Sie im Meter Change-Dialogfeld 
eine neue Position oder Taktart für das 
Taktart-Event ein.

3 Klicken Sie auf OK.

So löschen Sie ein Taktart-Event:

 Klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) auf das 
Taktart-Event.

So kopieren Sie mehrere Taktart-Events und fügen 
sie an anderen Positionen ein:

1 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

2 Selektieren Sie durch Ziehen in der Meter-
Leiste den Bereich, der die gewünschten 
Taktart-Events enthält.

Wenn sich am Anfang einer Selektion ein Taktart-
Event befindet, drücken Sie die Strg-Taste 
(Windows) bzw. die Befehlstaste (Mac), um das 
Selector-Tool zu öffnen.

3 Wählen Sie Edit > Copy.

4 Klicken Sie in der Meter-Leiste auf die Stelle, an 
der Sie die Taktart-Events einfügen möchten.

5 Wählen Sie Edit > Paste. Der Inhalt der 
Zwischenablage wird am gewählten 
Einfügepunkt eingefügt. Alle bis dahin dort 
vorhandenen Taktart-Events werden ersetzt.

So erweitern Sie die Edit-Selektion in einer 
Spur auf die Meter-Leiste:

1 Selektieren Sie mit dem Selector- oder einem 
Grabber-Tool einen Spurabschnitt.

2 Klicken Sie bei gedrückter Umschalttaste 
auf die Meter-Leiste.

Um die Meter-Leiste wieder aus der Selektion 
zu entfernen, klicken Sie erneut bei gedrückter 
Umschalttaste auf die Meter-Leiste.

Bei einigen Taktarten kann es von Vorteil sein, 
punktierte Notenwerte als Metronomwert 
zu verwenden. Beispielsweise ist bei einem 6/8-
Takt eine punktierte Viertelnote (also zwei Klicks 
pro Takt als Metronomwert) in der Regel 
geeigneter als eine Achtelnote (sechs Klicks pro 
Takt).

Eingefügtes Taktart-Event

Um eine Selektion in allen Dirigentenspuren 
vorzunehmen, halten Sie beim Ziehen die 
Alt-Taste (Windows) bzw. die Wahltaste 
(Mac) gedrückt.
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So selektieren Sie sämtliche Taktart-Events:

 Doppelklicken Sie mit dem Selector-Tool auf 
die Meter-Leiste.

So löschen Sie die Taktart-Events in einem 
selektierten Bereich:

1 Stellen Sie den Edit-Modus gegebenenfalls 
auf „Grid“ ein, um die Selektion durch das 
aktuell eingestellte Raster zu begrenzen. 

2 Ziehen Sie über einen Bereich in der Meter-
Leiste, um die zu löschenden Taktart-Events 
zu selektieren.

3 Wählen Sie Edit > Clear, um die selektierten 
Taktart-Events zu löschen.

Unvollständige Takte
Damit das eingefügte Taktart-Event in das 
restliche Taktschema passt, erzeugt Pro Tools 
gegebenenfalls einen unvollständigen Takt. 
Ein auf einen solchen unvollständigen Takt 
folgendes Taktart-Event wird in der Meter-Leiste 
kursiv angezeigt.

Solche unvollständigen Takte können ebenfalls 
vorkommen, wenn Taktart-Events an beliebigen 
Positionen und nicht auf dem ersten Schlag eines 
Taktes eingefügt werden.

Time Operations
Im Time Operations-Fenster haben Sie folgende 
Möglichkeiten:

• Change Meter

• Insert Time

• Cut Time

• Move Song Start

So öffnen Sie ein bestimmtes Time 
Operations-Fenster:

 Wählen Sie Event > Time Operations und 
danach einen der Time Operations-Befehle 
(etwa Change Meter).

So öffnen Sie das letzte aktive Time 
Operations-Fenster:

 Wählen Sie Event > Time Operations > Time 

Operations Window.

Unvollständiger 4/4-Takt

Um beim Einfügen von Taktart-Events 
unvollständige Takte zu vermeiden, 
verwenden Sie den Change Meter-Befehl 
im Time Operations-Fenster. Siehe „Change 
Meter“ auf Seite 825.

Wenn das Time Operations-Fenster bereits 
geöffnet ist, können Sie über das Popup-
Menü oben im Fenster die gewünschte Time 
Operations-Option ansteuern.

Drücken Sie Alt + 1 (Windows) bzw. Wahl + 1 
(Mac) auf dem Ziffernblock, um das 
Time Operations-Fenster zu öffnen und 
das zuletzt aktive Time Operations-
Fenster anzuzeigen.
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Change Meter
Auf der Change Meter-Seite des Time Operations-
Fensters können Sie komplexe Taktartänderungen 
für Bar|Beat-basiertes Material vornehmen. 
Sie können die Taktartänderungen an einem 
bestimmten Takt eingeben, eine Taktänderung 
für einen ausgewählten Zeitraum festlegen 
oder sequenziell für jeden Takt eine 
Taktänderung vornehmen.

Beispiele für Change 
Meter-Vorgänge

So ändern Sie die Taktart in einem Bereich von 
mehreren Takten:

1 Sie haben folgende Möglichkeiten:

• Ziehen Sie mit dem Selector-Tool, um die Reihe 
von Takten zu selektieren, die geändert werden 
soll.

• Wenn die Taktartänderung bis zum Beginn des 
nächsten Taktart-Events angewendet werden 
soll, klicken Sie mit dem Selector-Tool an die 
Stellen, an der die Änderung wirksam werden 
soll. Die Taktartänderung tritt mit Beginn des 
nächsten Takts in Kraft.

2 Wählen Sie Event > Time Operations > 

Change Meter.

3 Geben Sie eine neue Taktart und 
Metronomeinstellung an. Pro Tools legt 
die Selektionsoptionen automatisch fest; diese 
sind notwendig, um die ausgewählte Taktart 
durch Hinzufügen bzw. Entfernen von Schlägen 
so gut wie möglich an den selektierten 
Bereich anzupassen.

4 Wählen Sie im Apply Change-Popup-Menü 
die Option To Selected Range.

5 Wählen Sie aus, welche Leisten und Spuren 
nach Taktartänderungen neu ausgerichtet 
werden sollen.

6 Klicken Sie auf Apply.

So nehmen Sie Takt für Takt eine Reihe von 
Taktartänderungen vor:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Selector-Tool auf die Stelle 
in einer Spur, an der die Änderung beginnen soll. 
Die Taktartänderung tritt mit Beginn des 
nächsten Takts in Kraft.

• Geben Sie die erste Taktnummer in das Starting 
At Bar-Feld ein. 

2 Wählen Sie Event > Time Operations > 

Change Meter.

3 Geben Sie eine neue Taktart und 
Metronomeinstellung an. 

4 Wählen Sie im Apply Change To-Popup-Menü 
die Option Until the Next Bar.

5 Klicken Sie auf Apply, um die neue Taktart 
einzugeben und den Einfügepunkt an das Ende 
des neuen Takts zu verschieben.

6 Geben Sie eine neue Taktart und 
Metronomeinstellung für den nächsten Takt an.

7 Wiederholen Sie die Schritte 5 und 6 für jede 
weitere Taktartänderung.

Change Meter-Fenster



Pro Tools-Referenzhandbuch826

Change Meter-Optionen
Der Change Meter-Befehl bietet folgende Optionen:

New Meter. – hier können Sie eine neue Taktart 
angeben. Geben Sie im ersten Feld die Anzahl der 
Schläge (bis 99) in einem Takt, im zweiten die 
Länge der Note ein, die als ein Schlag zählt.

Klicken Sie auf. – hier können Sie den Notenwert 
angeben, der den Metronom-Klick auslösen soll. 
Wenn Sie beispielsweise eine Achtelnote 
auswählen, wird unabhängig vom Tempo für jede 
Achtelnote ein Metronom-Klick ausgegeben.

Starting at Bar. – legt den Takt fest, an dem 
die Taktartänderung eingegeben wird. 
Taktartänderungen in der Change Meter-Seite 
können nur am Taktanfang vorgenommen werden.

Apply Change To. – hier können Sie die 
Taktartänderung auf den ausgewählten Bereich, 
das Ende einer Session oder bis zum nächsten 
Takt hin anwenden. 

Change. – in den Change-Feldern können Sie die 
Anzahl der Takte der neuen Taktart eingeben, 
die den selektierten Bereich ersetzen sollen.

Pro Tools berechnet automatisch die nächstliegende 
Anzahl von Takten; Sie können die Anzahl von 
Takten auch manuell eingeben. Beim Überschreiben 
des berechneten Bereichs wird am Ende der Selektion 
bei allen betroffenen Takten Zeit je nach Bedarf 
taktweise hinzugefügt oder entfernt.

Realign

Mit den Realign-Steuerelementen können 
Sie auswählen, welche Elemente nach einer 
Taktartänderung wieder neu ausgerichtet werden 
sollen. Dabei haben Sie die Wahl zwischen 
folgenden Elementen: Taktart-Events, Taktart- 
und Tempo-Events, tickbasierte Marker und 
Spuren sowie alle oder keine der samplebasierten 
Marker und Spuren.

Meter Ruler Only. – wendet die Taktartänderung 
an und richtet nur die Meter-Leiste neu aus. Alle 
anderen Leisten und Spuren sind von den 
Änderungen nicht betroffen.

„Meter, Tempo, Key, and Chord Rulers, all Tick-
Based Markers and Tracks“ und „Sample-Based 
Markers and Tracks“. – wenden die 
Taktartänderung an und richten die Meter-, 
Tempo-, Key- und Chords-Leiste und alle 
tickbasierten Marker und Spuren aus. Über das 
Popup-Menü können Sie auch auswählen, alle (All) 
oder keine (No) samplebasierten Marker und 
Spuren neu auszurichten. Am Ende der Selektion 
wird je nach Bedarf Zeit hinzugefügt oder entfernt, 
um die Ausrichtung des Materials nach der 
Selektion zu erhalten.
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Insert Time
Auf der Insert Time-Seite des Time Operations-
Fensters können Sie leere Zeitbereiche (Stille) in 
Dirigentenleisten, MIDI- und Audiospuren einfügen.

Beispiel für Insert 
Time-Vorgänge

So fügen Sie vier leere 4/4-Takte in eine 
Session ein:

1 Stellen Sie die Haupt-Zeitskala auf 
„Bars|Beats“ ein.

2 Wählen Sie Event > Time Operations > 

Insert Time.

3 Geben Sie im Start-Feld den Takt an, in dem Sie 
die Takte einfügen möchten. 

4 Geben Sie im Length-Feld vier Takte an.

5 Wählen Sie die Realign-Optionen Meter, 

Tempo, Key, and Chord Rulers, Tick-Based 

Markers and Tracks und All Sample-Based 

Markers and Tracks.

6 Klicken Sie auf Apply.

Insert Time-Optionen
Der Insert Time-Befehl bietet folgende Optionen:

Start, End, Length. – hiermit legen Sie den Start- 
und Endpunkt bzw. die Länge der Selektion fest. 

Set Meter. – wenn die Haupt-Zeitskala auf 
„Bars|Beats“ eingestellt ist, können Sie mit der 
Set Meter-Option eine neue Taktart für die 
eingefügte Zeit angeben. Die Selektion wird auf 
die nächsten Takte quantisiert und die vorherige 
Taktart nach der Selektion eingefügt. Bei einer 
samplebasierten Haupt-Zeitskala ist die Set Meter-
Option nicht verfügbar.

Realign

Mit den Realign-Einstellungen können 
Sie festlegen, welche Elemente beim Einfügen von 
Zeit verschoben werden (später auftreten):

• Wenn die Haupt-Zeitskala auf „Bars|Beats“ 
eingestellt ist, können Sie wählen, ob nur Taktart-
Events oder aber eine Kombination aus Meter- und 
Tempo-Leiste, allen tickbasierten Markern und 
Spuren und den von Ihnen bestimmten 
samplebasierten Spuren neu ausgerichtet werden 
sollen.

• Bei einer absoluten Zeitbasis (etwa „Min:Sec“) 
in der Haupt-Zeitskala können Sie Dirigenten-
Events, tickbasierte Marker und Spuren und alle 
oder keine samplebasierten Spuren unabhängig 
neu ausrichten. 

Meter Ruler Only. – wenn die Haupt-Zeitskala auf 
„Bars|Beats“ eingestellt ist, haben Sie die Möglichkeit, 
Zeit nur in die Meter-Leiste einzufügen. Taktart-
Events nach dem Startpunkt der Selektion werden um 
die Selektionslänge über das Ende der Selektion 
hinaus verschoben. 

Bei einer samplebasierten Haupt-Zeitskala ist die 
Realign-Option Meter Ruler Only nicht verfügbar.

Insert Time-Fenster
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„Meter, Tempo, Key, and Chord Rulers, all Tick-
Based Markers and Tracks“ und „Sample-Based 
Markers and Tracks“. – hiermit können Sie Zeit in 
die Meter-, Tempo-, Key- und Chords-Leiste und 
in alle tickbasierten Marker und Spuren einfügen. 
Events nach dem Startpunkt der Selektion werden 
um die Länge der eingefügten Zeit über den 
Endpunkt hinaus verschoben. 

Wenn die Timeline-Selektion Audioclips auf 
tickbasierten Spuren enthält, werden die 
Audioclips beim Startpunkt getrennt und der neue 
Clip mit der vorherigen Selektion wird zum 
Endpunkt hin verschoben.

Über das Popup-Menü können Sie auch 
auswählen, Zeit in alle (All) oder keine (No) 
samplebasierten Marker und Spuren einzufügen. 
Wenn All ausgewählt ist und die Selektion 
Audioclips auf samplebasierten Spuren enthält, 
werden die Audioclips beim Startpunkt getrennt 
und der neue Clip mit der vorherigen Selektion 
wird zum Endpunkt hin verschoben.

Cut Time 
Auf der Cut Time-Seite des Time Operations-
Fensters können Sie einen bestimmten Zeitbereich 
(Zeitbasis- und Spurdaten) aus Dirigentenleisten, 
MIDI-Spuren und Audiospuren ausschneiden.

Beispiel für Cut Time-Vorgänge

So schneiden Sie 30 Sekunden aus einer 
Session aus:

1 Setzen Sie die Haupt-Zeitskala auf 
„Minutes:Seconds“.

2 Wählen Sie Event > Time Operations > 
Cut Time.

3 Klicken Sie mit dem Selector-Tool auf den Anfang 
des Bereichs, den Sie ausschneiden möchten. 

4 Geben Sie im Length-Feld 30 Sekunden 
(0:30.000) ein.

5 Wählen Sie die Realign-Optionen Meter, 
Tempo, Key, and Chord Rulers, all Tick-Based 
Markers and Tracks und All Sample-Based 
Markers and Tracks.

6 Klicken Sie auf Apply.

Cut Time-Optionen
Der Cut Time-Befehl bietet folgende Optionen:

Start, End, Length. – hiermit legen Sie den Start- 
und Endpunkt bzw. die Länge der Selektion fest. 

Realign

Mit den Realign-Optionen können Sie festlegen, 
welche Elemente beim Ausschneiden von 
Zeit verschoben werden:

• Wenn die Haupt-Zeitskala auf „Bars|Beats“ 
eingestellt ist, können Sie wählen, ob nur Taktart-
Events oder aber eine Kombination aus Meter- und 
Tempoleiste, allen tickbasierten Markern und 
Spuren und den von Ihnen bestimmten 
samplebasierten Spuren neu ausgerichtet werden 
sollen.

• Bei einer absoluten Zeitbasis (etwa „Min:Sec“) 
in der Haupt-Zeitskala können Sie Dirigenten-
Events, tickbasierte Marker und Spuren und alle 
oder keine samplebasierten Spuren unabhängig 
neu ausrichten. 

Cut Time-Fenster
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Meter Ruler Only. – wenn die Haupt-Zeitskala auf 
„Bars|Beats“ eingestellt ist, haben Sie die Möglichkeit, 
Zeit nur aus der Meter-Leiste zu entfernen. Taktart-
Events innerhalb der Selektion werden entfernt, 
während jene nach dem Endpunkt der Selektion zum 
Startpunkt der Selektion hin verschoben werden. 

Bei einer samplebasierten Haupt-Zeitskala ist die 
Realign-Option Meter Ruler Only nicht verfügbar.

„Meter, Tempo, Key, and Chord Rulers, all Tick-
Based Markers and Tracks“ und „Sample-Based 
Markers and Tracks“. – hiermit schneiden 
Sie Zeitbereiche aus und richten die Meter-, 
Tempo-, Key- und Chords-Leiste und alle 
tickbasierten Marker und Spuren aus. 

Wenn die Zeitselektion tickbasierte Clips enthält, 
werden der selektierte Bereich der Clips gelöscht 
und die der Selektion folgenden Clips nach 
vorn verschoben.

Über das Popup-Menü können Sie auch 
auswählen, Zeit aus allen (All) oder keinen (No) 
samplebasierten Markern und Spuren 
auszuschneiden. Wenn All ausgewählt ist und die 
Selektion Audioclips auf samplebasierten Spuren 
enthält, werden der selektierte Bereich der Clips 
gelöscht und die der Selektion folgenden Clips 
nach vorne verschoben.

Move Song Start 
Auf der Move Song Start-Seite des Time-
Operations-Fensters können Sie die Position 
des Songstart-Markers neu festlegen.

Beispiel für Move 
Song Start-Vorgänge

So verschieben Sie den Songstart-Marker auf der 
Timeline um 15 Sekunden:

1 Wählen Sie Event > Time Operations > Move 

Song Start.

2 Wählen Sie im Timebase-Popup-Menü die 
Minutes:Seconds-Option. 

3 Geben Sie im Feld „Move Song Start To“ den 
Wert „0:15:000“ ein, um den Songstart 15 
Sekunden nach vorn zu verschieben.

4 Wenn Sie die Takte neu nummerieren möchten, 
sodass der Songstart-Marker an einem anderen 
Takt positioniert ist, wählen Sie die Option 
Renumber Song Start und geben Sie die 
Taktnummer ein.

5 Wählen Sie, ob Sie alle (All) samplebasierten 
Markers und Spuren verschieben möchten oder 
keine (No) von ihnen. 

6 Klicken Sie auf Apply.

Move Song Start-Fenster
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Move Song Start-Optionen
Der Move Song Start-Befehl bietet folgende Optionen:

Timebase. – hier können Sie die von einer 
beliebigen unterstützten Zeitbasis gemessene 
Position des Songstart-Markers präzise 
neu definieren.

Move Start To. – hiermit legen Sie die Position 
des Songstart-Markers in der ausgewählten 
Zeitbasis fest. 

Renumber Song Start To. – wenn diese Option 
aktiviert ist, können Sie für den Songstart-Marker 
eine beliebige Taktnummer eingeben.

Move

Mit den Move-Befehlen können Sie bestimmen, 
welche Elemente beim Verschieben des Songstart-
Markers ebenfalls verschoben werden:

Song Start Only. – verschiebt nur den Songstart-
Marker.

„Meter, Tempo, Key, and Chord Rulers, all Tick-
Based Markers and Tracks“ und „Sample-Based 
Markers and Tracks“. – verschieben den Songstart-
Marker, Events in den Meter-, Tempo-, Key- und 
Chords-Leisten, alle tickbasierten Marker und 
Spuren und Ihre Selektion von allen oder keinen 
samplebasierten Markern und Spuren.

Neunummerieren von Takten
Mit dem Renumber Bars-Befehl können Sie alle 
Takte in einer Session neu nummerieren, indem 
Sie die Taktpositionen sämtlicher Clips, Taktart-
Events und Tempo-Events umbenennen, ohne 
jedoch tatsächlich ihre Position zu ändern. 
Die Neunummerierung der Taktpositionen hat 
ebenfalls keine Auswirkung auf die SMPTE- und 
Samplepositionen der Session.

So nummerieren Sie Takte neu:

1 Wählen Sie Event > Renumber Bars.

2 Geben Sie den Takt ein, dessen Nummer 
Sie ändern möchten. Geben Sie dann die neue 
Nummer für den Takt ein und klicken 
Sie auf „Renumber“.

Renumber Bars-Dialogfeld
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Generalvorzeichen
Mit der Key Signature-Leiste können Sie 
Pro Tools-Sessions Generalvorzeichen 
hinzufügen. Generalvorzeichen können mit MIDI-
Daten importiert und exportiert werden. Dies ist 
besonders nützlich, wenn Sie MIDI-Sequenzen zur 
Verwendung in Notensatzprogrammen 
wie Sibelius exportieren (siehe „Exportieren von 
Sibelius-Dateien“ auf Seite 346). 
Das Standardgeneralvorzeichen ist C-Dur.

Key Signature-Leiste
Mit der Key Signature-Leiste können Sie 
Generalvorzeichen hinzufügen, bearbeiten und 
löschen. Mithilfe von Generalvorzeichen können 
Sie Tonarten und Tonartänderungen in Ihrer 
Pro Tools-Session angeben. Generalvorzeichen 
können auch für bestimmte diatonische 
Funktionen, wie das Transponieren in einer Tonart 
oder das Beschränken von Tonhöhen auf die 
angegebene Tonart, verwendet werden.

Führen Sie einen der folgenden Schritte aus, um 
die Key Signature-Leiste anzuzeigen:

 Aktivieren Sie View > Rulers > Key Signature.

 Wählen Sie im Ruler View-Selektor des Edit-
Fensters Key.

Sie können auch das Notensystem des 
Generalvorzeichens für die Key Signature-
Leiste ein- oder ausblenden.

So können Sie die Notenzeile für die Key 
Signature-Leiste anzeigen:

1 Zeigen Sie die Key Signature-Leiste an.

2 Sie haben folgende Möglichkeiten:

• Aktivieren Sie View > Rulers > Key Signature 

Staff.

• Klicken Sie auf der Key Signature-Leiste auf 
das Dreieck zum Ein-/Ausblenden.

Ändern von Generalvorzeichen
Sie können Generalvorzeichen hinzufügen, 
bearbeiten oder löschen.

So fügen Sie ein Generalvorzeichen hinzu:

1 Platzieren Sie den Cursor in der Timeline an der 
Stelle, an der Sie ein Generalvorzeichen 
hinzufügen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Event > Add Key Change.

• Klicken Sie in der Key Signature-Leiste auf die 
Plus-Schaltfläche (+).

3 Wählen Sie im Key Change-Dialogfeld das 
Tongeschlecht (Dur oder Moll), die Tonart, 
die Position und den Bereich und wie Spuren 
bestimmter Tonhöhen davon beeinflusst 
werden sollen.

4 Klicken Sie auf OK.

So bearbeiten Sie ein Generalvorzeichen:

1 Doppelklicken Sie in der Key Signature-Leiste 
auf den Generalvorzeichen-Marker.

2 Nehmen Sie im Key Change-Dialogfeld 
Änderungen vor.

3 Klicken Sie auf OK.

Key Signature-Leiste
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Führen Sie einen der folgenden Schritte aus, 
um ein Generalvorzeichen zu löschen:

 Klicken Sie in der Key Signature-Leiste bei 
gedrückter Alt-Taste (Windows) bzw. Wahltaste 
(Mac) auf den Generalvorzeichen-Marker.

 Treffen Sie in der Key Signature-Leiste eine 
Selektion mit den Generalvorzeichen, die Sie 
löschen möchten, und wählen Sie Edit > Clear 
oder drücken Sie die Entf-Taste.

Key Change-Dialogfeld
Im Key Change-Dialogfeld können Sie das 
Tongeschlecht (Dur oder Moll), die Tonart 
(von sieben Bs bis zu sieben Kreuzen) oder 
den betroffenen Bereich (etwa von Takt 1 bis zur 
nächsten Tonartänderung) angeben und festlegen, ob 
MIDI-Noten auf Spuren bestimmter Tonhöhen 
transponiert oder auf eine Tonart beschränkt werden 
sollen (siehe „Spuren mit bestimmter Tonhöhe“ auf 
Seite 833). Das Key Change-Dialogfeld wird 
geöffnet, wenn Sie einen Generalvorzeichen-Marker 
hinzufügen oder bearbeiten.

Major Keys. – zeigt die Dur-Tonarten von sieben 
Bs bis zu sieben Kreuzen an.

Minor Keys. – zeigt die Moll-Tonarten von sieben 
Bs bis zu sieben Kreuzen an. Pro Tools verwendet 
nur natürliches Moll.

Sharps. – Sie können eine beliebige erhöhte 
Tonart mit bis zu sieben Kreuzen und C-Dur (oder 
a-Moll) auswählen.

Flats. – Sie können eine beliebige erniedrigte 
Tonart mit bis zu sieben Bs und C-Dur 
(oder a-Moll) auswählen.

From. – Sie können angeben, wo der 
Generalvorzeichen-Marker in „Bars|Beats“ 
positioniert wird.

So. – Sie können angeben, worauf die 
Tonartänderung angewendet wird: auf den 
nächsten Generalvorzeichen-Marker, auf eine 
Selektion oder auf das Ende der Session.

Snap to Bar. – fügt den Generalvorzeichen-
Marker am Taktstrich ein.

Edit Pitched Tracks. – wenn Sie die Edit Pitched 
Tracks-Option aktivieren, können Sie vorhandene 
MIDI-Noten auf Spuren bestimmter Tonhöhen 
ausgehend von der Tonartänderung diatonisch oder 
chromatisch nach oben oder unten transponieren oder 
Tonhöhen auf die neue Tonart beschränken. Weitere 
Informationen zu Spuren bestimmter Tonhöhen 
finden Sie unter „Spuren mit bestimmter Tonhöhe“ 
auf Seite 833.

Transpose. – wenn die Edit Pitched Tracks-
Option aktiviert ist, können Sie vorhandene MIDI-
Noten auf Spuren bestimmter Tonhöhen 
diatonisch oder chromatisch nach oben oder unten 
transponieren. Wenn Sie beispielsweise bei einer 
Session in C-Dur eine Tonartänderung auf d-Moll 
hinzufügen, wählen Sie „Edit Pitched Tracks“, 
„Transpose“, „Up“ und „Diatonically“, um Noten 
auf Spuren bestimmter Tonhöhen um eine ganze 
Stufe nach oben zu transponieren, und reduzieren 
Sie dann die dritte, sechste und siebte Akkordstufe 
um eine halbe Stufe. Die Sequenz C, D, E wird auf 
D, E, F transponiert (mit Auflösungszeichen im 
Gegensatz zum Kreuz wie beim chromatischen 
Transponieren). 

Key Change-Dialogfeld
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Beim diatonischen Transponieren werden 
chromatische Noten beibehalten, wenn sich die 
Tonart ändert. Wenn zum Beispiel C-Dur zu E-Dur 
geändert wird, wird die Note B zu D mit 
Auflösungszeichen transponiert. Dadurch können 
Sie beim Ändern von Tonarten und Anwenden einer 
diatonischen Transposition Bluenotes beibehalten.

Constrain Pitches To Key. – wenn die Option „Edit 
Pitched Tracks“ aktiviert ist, können Sie Tonhöhen 
auf Noten der neuen Tonart beschränken. Damit 
werden diatonische Tonhöhen der alten Tonart 
auf Spuren bestimmter Tonhöhen, die nicht in der 
neuen Tonart enthalten sind, einzeln auf die 
nächstgelegene diatonische Tonhöhe der neuen 
Tonart transponiert. Beispiel: Bei einer Änderung 
von C-Dur zu D-Dur wird die Sequenz C, D, E, F, G 
zu Cis, D, E, Fis, G geändert.

Wenn Tonhöhen auf eine Tonart beschränkt werden, 
werden auch chromatische Tonhöhen auf die neue 
diatonische Stufe beschränkt. Beispiel: Bei einer 
Änderung von C-Dur zu D-Dur wird die Sequenz C, 
D, Dis, E zu Cis, D, D, E geändert.

Spuren mit bestimmter Tonhöhe
Spuren mit bestimmter Tonhöhe sind MIDI- oder 
Instrumentenspuren, auf die sich Transpositionen 
aufgrund von Tonartänderungen (einschließlich der 
Beschränkung auf eine Tonart) auswirken können. 
MIDI- und Instrumentenspuren sind standardmäßig 
auf bestimmte Tonhöhen ausgelegt. Wenn jedoch 
MIDI- oder Instrumentenspuren Drum Machines 
oder Samplern zugewiesen sind, möchten Sie nicht, 
dass diese Spuren durch Tonartänderungen aufgrund 
von Tonartzuweisungen beeinflusst werden. Sie 
können die Pitched-Option für spezifische MIDI- 
und Instrumentenspuren deaktivieren, damit sich 
Tonartänderungen nicht auf sie auswirken.

So aktivieren (oder deaktivieren) Sie Spuren mit 
bestimmter Tonhöhe:

 Klicken Sie auf den Playlist-Selektor der Spur 
und aktivieren (oder deaktivieren) Sie die 
Pitched-Option.

Importieren von 
Generalvorzeichen
Beim Importieren von MIDI-Dateien 
(oder Session-Daten mit MIDI-Dateien) können 
Sie auswählen, ob in MIDI-Dateien gespeicherte 
Generalvorzeichen importiert werden oder nicht.

MIDI importieren

Das Import MIDI-Dialogfeld enthält die Option 
Import Key Signature from MIDI File. Wenn diese 
Option ausgewählt ist, werden Generalvorzeichen 
(falls vorhanden) mit anderen MIDI-Daten in 
Pro Tools importiert.

Pitched-Option im Playlist-Selektor aktiviert

Import MIDI-Dialogfeld
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Session-Daten importieren

Das Import Session Data-Dialogfeld enthält 
die Option Import Key Signature/Chord Map. 
Wenn diese Option ausgewählt ist, werden 
Generalvorzeichen (falls vorhanden) und Akkord-
Marker (falls vorhanden) mit den importierten 
Session-Daten in die aktuelle Session importiert.

Akkordsymbole
Mit der Chord Symbols-Leiste können Sie 
Akkordsymbole zu Pro Tools-Sessions im Edit-
Fenster und in MIDI Editor-Fenstern hinzufügen. 
Sie können Akkordsymbole und -diagramme auch 
in Score Editor hinzufügen („Akkordsymbole und 
-diagramme“ auf Seite 775). 

Akkordsymbole haben keine Auswirkungen auf 
MIDI-Daten. Außerdem werden Akkordsymbole 
beim Exportieren von MIDI-Daten aus Pro Tools 
in eine MIDI-Datei nicht berücksichtigt. Beim 
Export in eine Sibelius-Datei (.sib) hingegen oder 
beim Verwenden des Befehls Send to Sibelius 
werden Akkordsymbole berücksichtigt.

Chord Symbols-Leiste
Mit der Chord Symbols-Leiste können Sie 
Akkordsymbole hinzufügen, bearbeiten und 
löschen. Mithilfe von Akkordsymbolen können 
Sie die Akkordveränderungen in Ihrer Pro Tools-
Session angeben. 

Führen Sie einen der folgenden Schritte aus, 
um die Chord Symbols-Leiste anzuzeigen:

 Aktivieren Sie View > Rulers > Chord Symbols.

 Wählen Sie im Ruler View-Selektor des Edit-
Fensters oder eines MIDI Editor-Fensters 
die Option Chords.

So fügen Sie ein Akkordsymbol hinzu:

1 Platzieren Sie den Cursor in der Timeline an der 
Stelle, wo Sie ein Akkordsymbol hinzufügen 
möchten.

2 Sie haben folgende Möglichkeiten:

• Platzieren Sie den Cursor in der Timeline 
und klicken Sie dann im Chords-Lineal auf das 
Pluszeichen (+).

• Bewegen Sie den Cursor bei gedrückter 
Windows-Taste (Windows) bzw. ctrl-Taste (Mac) 
in das Chords-Lineal (der Cursor verwandelt sich 
in einen Grabber mit einem kleinen Pluszeichen) 
und klicken Sie auf die Position, an der das 
Akkordsymbol eingefügt werden soll.

Session-Daten importieren

Chord Symbols-Leiste

Chords-Leiste
Akkordsymbol hinzufügen

Chord Symbol-Marker
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3 Wählen Sie im Chord Change-Dialogfeld den 
Namen für den Grundton des Akkords, 
die Akkordqualität, die Bassnote des Akkords 
und das gewünschte Akkorddiagramm aus. 
(Akkorddiagramme werden nur im Score Editor 
angezeigt.)

4 Klicken Sie auf OK.

So ändern Sie ein Akkordsymbol:

1 Doppelklicken Sie im Chord Symbol-Lineal auf 
den Akkordsymbol-Marker.

2 Nehmen Sie im Chord Change-Dialogfeld 
Änderungen vor.

3 Klicken Sie auf OK.

So verschieben Sie ein Akkordsymbol:

 Ziehen Sie den Akkordsymbol-Marker an eine 
neue Zeitposition.

Führen Sie einen der folgenden Schritte aus, 
um ein Akkordsymbol zu löschen:

 Klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) auf den 
Akkordsymbol-Marker im Chords-Lineal.

 Treffen Sie im Chords-Lineal eine Selektion 
mit den Akkordsymbolen, die Sie löschen 
möchten, und wählen Sie Edit > Clear oder 
drücken Sie die Entf-Taste.

Chord Change-Dialogfeld
Im Chord Change-Dialogfeld können Sie 
ein herkömmliches Akkordsymbol und ein 
Akkorddiagramm (Gitarrentabulatur) angeben, 
das im Chords-Lineal oder in der Partitur im Score 
Editor platziert werden soll. Das Chord Change-
Dialogfeld wird geöffnet, wenn Sie einen Akkord-
Marker hinzufügen oder bearbeiten.

Akkord. – wählen Sie den Namen für den 
Grundton des Akkords aus (etwa D).

Chord Quality. – wählen Sie im Selektor das 
Tongeschlecht des Akkords (etwa „Major“ für 
Dur oder „Minor“ für Moll).

Bass. – wählen Sie den Basston des Akkords 
aus (etwa B für einen g-Moll-Akkord in 
erster Umkehrung).

Chord Diagram. – wählen Sie das 
Akkorddiagramm für die Gitarrentabulatur aus.

Chord Change-Dialogfeld

Zum Ein- oder Ausblenden von Akkordsymbolen 
und -diagrammen im Score Editor aktivieren oder 
deaktivieren Sie die entsprechende Option im 
Score Setup-Dialogfeld.

Chord-Selektor Chord Quality-
Selektor

Bass Note-
Selektor

Chord Diagrams
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Kapitel 36: Memory Locations

Memory Locations eignen sich für die Navigation in 
der Session, während Sie editieren und anordnen. 

In jeder Session können bis zu 999 sogenannte 
Memory Locations dazu verwendet werden, folgende 
Einstellungen zu speichern und aufzurufen:

• Marker wichtiger Positionen einer Session

• Edit-Selektionen innerhalb einer Spur oder über 
mehrere Spuren

• Aufnahme- und Wiedergabebereiche zusammen 
mit den Einstellungen für Pre- und Post-Roll-
Zeiten

• Spurspezifische Einstellungen wie Ein- oder 
Ausblendestatus, Darstellungshöhe (Track Height) 
und Zoom-Werte

• Konfiguration von Edit- und Mix-Gruppen

• Fensterkonfigurationen

Die Memory Locations sind im Memory Locations-
Fenster angeordnet, von wo aus sie durch Anklicken 
aufgerufen werden können.

Erstellen von 
Memory Locations
Es gibt drei verschiedene Möglichkeiten zur 
Erzeugung von Memory Locations, abhängig von 
ihrem Typ:

Marker Memory Location. – verweist auf einen 
bestimmten Punkt in der Timeline.

Selection Memory Location. – verweist auf eine 
Edit-Selektion.

General Properties Memory Location. – verweist 
auf eine Kombination von Session-Einstellungen 
(etwa Zoom-Einstellungen, Pre- und Post-Roll-
Zeiten, spurspezifische Einstellungen wie Ein-/ 
Ausblendestatus und Darstellungshöhe sowie 
die Konfiguration von Edit- und Mix-Gruppen).

Wenn Sie eine Memory Location erzeugen, wird 
ihr die nächste verfügbare Nummer (zwischen 
1 und 999) zugewiesen. Durch Eingabe dieser 
Nummer auf dem Ziffernblock können Sie die 
Memory Location aufrufen.
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So erzeugen Sie eine Marker Memory Location:

1 Konfigurieren Sie alle Einstellungen einer 
Session, die innerhalb der Marker Memory 
Location gespeichert werden sollen. Dazu 
gehören beispielsweise die Zoom-Einstellungen, 
die Pre- und Post-Roll-Zeiten, spurspezifische 
Einstellungen wie Ein-/Ausblendestatus und 
Darstellungshöhe (Track Height) sowie die 
Konfiguration der Edit- und Mix Groups.

2 Aktivieren Sie ggf. Options > Link Timeline 

and Edit Selection.

3 Stellen Sie sicher, dass die Markers-Leiste 
angezeigt wird (View > Rulers > Markers).

4 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Selector-Tool auf die Stelle 
einer Spur oder einer Leste, an der Sie den Marker 
platzieren möchten. Um einen Marker am Anfang 
eines Clips zu positionieren, selektieren Sie den 
Clip mit dem Time Grabber-Tool. Klicken Sie auf 
die Add Marker/Memory Location-Schaltfläche 
(oder drücken Sie die Eingabetaste des 
Ziffernblocks).

• Bewegen Sie den Cursor bei gedrückter Windows-
Taste (Windows) bzw. ctrl-Taste (Mac) in die 
Markers-Leiste (der Cursor verwandelt sich in 
einen Grabber mit einem kleinen Pluszeichen) und 
klicken Sie auf die Position, an der der Marker 
platziert werden soll.

5 Aktivieren Sie im New Memory Location-
Dialogfeld die Marker-Option und wählen 
Sie unter „Reference“ entweder Bar|Beat 
oder Absolute.

6 Geben Sie einen Namen für den neuen Marker 
ein und wählen Sie unter „General Properties“ 
die Einstellungen, die mit dem Marker 
gespeichert werden sollen.

7 Klicken Sie auf OK. Der Marker wird erzeugt 
und erscheint nun in der Markers-Leiste sowie 
im Memory Locations-Fenster.

So erzeugen Sie eine Selection Memory Location:

1 Konfigurieren Sie alle Einstellungen einer 
Session, die innerhalb der Selection Memory 
Location gespeichert werden sollen. Dazu 
gehören beispielsweise die Zoom-Einstellungen, 
die Pre- und Post-Roll-Zeiten, spurspezifische 
Einstellungen wie Ein-/Ausblendestatus und 
Darstellungshöhe (Track Height) sowie die 
Konfiguration von Edit- und Mix-Gruppen.

2 Selektieren Sie einen Bereich auf einer oder 
mehreren Spuren. 

3 Sie haben folgende Möglichkeiten:

• Drücken Sie die Enter-Taste auf dem Ziffernblock.

• Wählen Sie aus dem Menü im Memory 
Locations-Fenster Add Memory Location.

4 Aktivieren Sie im New Memory Location-
Dialogfeld die Selection-Option und wählen 
Sie unter „Reference“ entweder Bar|Beat 
oder Absolute.

Add Marker/Memory Location (Schaltfläche)

Manuelles Einfügen eines Markers
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5 Geben Sie einen Namen für die neue Memory 
Location ein und wählen Sie unter „General 
Properties“ die Einstellungen, die mit ihr 
gespeichert werden sollen.

6 Klicken Sie auf OK. Die Selection Memory 
Location wird erzeugt und im Memory 
Locations-Fenster angezeigt.

So erzeugen Sie eine General Properties 
Memory Location:

1 Konfigurieren Sie alle Einstellungen einer Session, 
die innerhalb der Selection Memory Location 
gespeichert werden sollen. Dazu gehören 
beispielsweise die Zoom-Einstellungen, die Pre- 
und Post-Roll-Zeiten, spurspezifische 
Einstellungen wie Ein-/Ausblendestatus und 
Darstellungshöhe (Track Height) sowie die 
Konfiguration von Edit- und Mix-Gruppen.

2 Drücken Sie die Enter-Taste auf dem 
Ziffernblock.

3 Wählen Sie im Memory Location-Dialogfeld 
die None-Option.

4 Geben Sie einen Namen für die neue Memory 
Location ein und wählen Sie unter „General 
Properties“ die Einstellungen, die mit ihr 
gespeichert werden sollen.

5 Klicken Sie auf OK. Die General Properties 
Memory Location wird erzeugt und im Memory 
Locations-Fenster angezeigt.

Erstellen von Memory 
Locations während 
der Wiedergabe
Wenn in den Editing-Voreinstellungen die Option 
Auto-Name Memory Locations When Playing 
ausgewählt ist, können Memory Locations während 
der Wiedergabe erzeugt werden, ohne dass dafür das 
New Memory Location-Dialogfeld geöffnet werden 
muss. Diese Option kann auch aus dem Menü im 
Memory Locations-Fenster ausgewählt werden.

Diese Funktion ist nützlich, wenn Sie beim 
Anhören und Überprüfen einer Aufnahme oder 
beim Ansehen einer Videopassage bestimmte 
Positionen markieren möchten.

So erzeugen Sie einen Marker während 
der Wiedergabe:

1 Wählen Sie aus dem Menü im Memory 
Locations-Fenster Default To Marker. Diese 
Einstellung setzt Marker als Standardtyp für 
neue Memory Locations fest.

2 Wählen Sie aus dem Menü im Memory Locations-
Fenster Auto-Name Memory Locations.

3 Wenn eingefügte Marker eine Bar|Beat-Referenz 
erhalten sollen, vergewissern Sie sich, dass die 
Haupt-Zeitskala auf „Bars:Beats“ eingestellt ist.

4 Klicken Sie im Transport-Fenster auf „Play“.

5 Wenn die gewünschte Position erreicht ist, 
drücken Sie die Enter-Taste auf dem 
Ziffernblock. Hierdurch wird automatisch 
ein Marker erzeugt und in der Markers-
Leiste angezeigt.

Automatisch erzeugte Marker werden aufsteigend 
nummeriert (etwa „Marker 1“, „Marker 2“ und 
„Marker 3“).

Sie können sämtliche Eigenschaften aktivieren 
bzw. deaktivieren, indem Sie im New Memory 
Location-Dialogfeld unter „General 
Properties“ bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) auf die entsprechende 
Option klicken. Außerdem können Sie den Status 
sämtlicher Einstellungen umkehren, indem Sie 
bei gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf eine der Optionen 
klicken.
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Wenn die Default To Marker-Option deaktiviert ist, 
werden neue Memory Locations des jeweils zuletzt 
verwendeten Typs erzeugt. Wenn Sie also zuletzt 
eine Selection Memory Location erzeugt hatten, wird 
dieser Typ auch während der Wiedergabe erzeugt. In 
diesem Fall basiert die Bezeichnung der erzeugten 
Memory Location auf der Startposition der 
jeweiligen Edit-Selektion, wobei das für die Haupt-
Zeitskala eingestellte Anzeigeformat (wie etwa 
2|2|305 oder 0:02.658) übernommen wird.

Eigenschaften von 
Memory Locations
Wenn Sie eine neue Memory Location erzeugen 
(siehe „Erstellen von Memory Locations“ auf 
Seite 837), werden Sie dazu aufgefordert, 
deren Time Properties und General Properties 
zu definieren.

Time Properties
Unter „Time Properties“ können Sie für eine 
Memory Location entweder „Marker“, „Selection“ 
oder „None“ einstellen. Mit der Einstellung wird 
festgelegt, welcher Typ von Memory Location 
erzeugt wird. Für jeden dieser Memory Location-
Typen können unter „General Properties“ weitere 
Einstellungen vorgenommen werden.

Wenn auf der Operation Preferences-
Registerkarte die Option „Use Separate Play 
and Stop Keys“ aktiviert ist, wird die 
Verwendung der Enter-Taste zum 
Hinzufügen von Memory Location-Markern 
außer Kraft gesetzt. Wenn diese Option 
aktiviert ist, geben Sie einen Punkt (.) ein und 
drücken Sie auf dem Ziffernblock die 
Eingabetaste, um einen Memory Location-
Marker hinzuzufügen. Mit dem Drücken der 
Eingabetaste wird der neue Marker erzeugt.

Memory Locations-Fenster
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Marker. – mit dieser Einstellung wird eine Timeline-
Position aufgerufen, die entweder eine Bar|Beat-
Position (tickbasiert) oder eine absolute Position 
(samplebasiert) sein kann. Wenn Sie eine Marker 
Memory Location aufrufen, bewegt sich 
der Playback-Cursor auf die Position des 
entsprechenden Markers und die im Transport-Fenster 
angezeigten Start- und Endzeiten werden aktualisiert. 
Wenn die Edit- und Timeline-Selektionen miteinander 
verknüpft sind, bewegt sich auch der Edit-Cursor an 
die Position des Markers.

Marker werden in der Markers-Leiste durch eine 
dünne gelbe Linie dargestellt, die sich über alle Spuren 
im Edit-Fenster hinweg erstreckt. Dadurch wird die 
Anordnung und Positionierung des Materials in den 
Spuren vereinfacht. Um die genaue Position eines 
Markers und seine General Properties-Einstellungen 
aufzurufen, klicken Sie in der Markers-Leiste auf den 
entsprechenden Marker.

Selektion. – mit dieser Einstellung wird eine Edit-
Selektion oder Edit-Cursor-Position aufgerufen, 
die entweder eine Bar|Beat-Selektion/-Position 
(tickbasiert) oder eine absolute Selektion/Position 
(samplebasiert) sein kann. Mit Selection Memory 
Locations ist es möglich, die verschiedenen Edit-
Selektionen auf einer oder mehreren Spuren 
zu speichern, um innerhalb einer Session schnell 
zwischen ihnen wechseln zu können. Wenn die 
Edit- und Timeline-Selektionen miteinander 
verknüpft sind, können Sie mit einer Selection 
Memory Location sowohl Aufnahme- als auch 
Wiedergabebereiche abrufen.

None. – mit dieser Option werden keine Time 
Properties-Einstellungen aufgerufen. Sie dient als 
Grundeinstellung der sogenannten General 
Properties Memory Location.

Bar|Beat and Absolute Reference

Durch die Einstellungen im Reference-Popup-Menü 
wird festgelegt, ob eine Marker Memory Location 
bzw. Selection Memory Location sich auf eine 
Taktposition oder auf eine absolute Zeitposition 
bezieht. Wenn als Einstellung „Bar|Beat“ ausgewählt 
ist, wird die Memory Location tickbasiert 
positioniert. Ihre Taktposition bleibt auch bei einem 
Tempowechsel unverändert, doch ändert sich ihre 
Beziehung zur absoluten Sampleposition 
entsprechend.

Wenn die Absolute-Einstellung ausgewählt ist, wird 
die Memory Location samplebasiert positioniert und 
ihre Taktposition ändert sich bei einem 
Tempowechsel. Ihre Sampleposition bleibt jedoch 
gegenüber dem Audiomaterial unverändert.

In der Markers-Leiste werden taktbezogene Marker 
(Bar|Beat) als gelbe Pfeile und zeitbezogene Marker 
(Absolute) als gelbe Rauten dargestellt.

Marker in der Markers-Leiste

Mit den Memory Locations können 
nur zusammenhängende Selektionen 
gespeichert werden. Nicht nebeneinander 
liegende Selektionen, die mit dem Object 
Grabber-Tool vorgenommen wurden, werden 
aufgerufen, als wären sie mit dem Time 
Grabber-Tool vorgenommen worden.

Bar|Beat-Marker (links) und Absolute-Marker (rechts)
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General Properties
Für alle drei Memory Location-Typen („Marker“, 
„Selection“ und „None“) können beliebig viele 
der folgenden General Properties-Einstellungen 
festgelegt werden:

Number. – ändern Sie die Nummer, um eine 
vorhandene Memory Location zu überschreiben 
oder um Memory Locations im Memory 
Locations-Fenster neu anzuordnen.

Name. – geben Sie für jede Memory Location 
einen Namen ein.

Zoom Settings. – ruft die horizontalen, Audio- 
und MIDI-Zoomwerte für Audio-, MIDI- und 
Instrumentenspuren auf.

Pre/Post Roll Times. – ruft spezifische Pre- und 
Post-Roll-Zeiten auf (jedoch nicht, ob diese 
aktiviert sind oder nicht). Wird diese Eigenschaft 
zusammen mit einer Selection Memory Location 
gespeichert, so werden Aufnahme- und 
Wiedergabebereiche mit den spezifischen Pre- und 
Post-Roll-Zeiten aufgerufen.

Ein-/Ausblenden von Spuren. – ruft den 
Darstellungsstatus (ausgeblendet/eingeblendet) 
von Spuren auf. Verwenden Sie diese Eigenschaft, 
um ausgewählte Spuren zum Editieren und 
Mischen gemeinsam darzustellen.

Track Heights. – ruft die spezifische Einstellung 
der Darstellungshöhe der Spuren auf. Verwenden 
Sie diese Option zusammen mit „Zoom Settings“, 
um beispielsweise für die samplegenaue 
Bearbeitung von Audiomaterial oder das Trimmen 
von MIDI-Noten verschieden detaillierte Edit-
Umgebungen aufzurufen.

Group Enables. – ruft die spezifische 
Konfigurationen von Edit- und Mix-Gruppen auf. 
Verwenden Sie diese Option, um Spuren für 
bestimmte Editier- und Mischvorgänge 
zu gruppieren, etwa wenn Sie alle 
Schlagzeugspuren stummschalten oder Fader für 
mehrere Spuren gemeinsam bedienen möchten.

Fensterkonfiguration. – ruft eine spezifische 
Fensterkonfiguration auf. Diese Option ist 
nützlich, um spezifische Fensterkonfigurationen 
aufzurufen und Editier- und Mischvorgänge 
auszuführen. Weitere Informationen zu 
Fensterkonfigurationen finden Sie unter 
„Fensterkonfigurationen“ auf Seite 189.

Anmerkungen
Für alle drei Memory Location-Typen („Marker“, 
„Selection“ und „None“) können Anmerkungen 
gespeichert und aufgerufen werden. Sie können im 
Comments-Feld bis zu 255 Zeichen zur 
Beschreibung der Memory Location eingeben. 
Sie können auch zuvor eingegebene Anmerkungen 
bearbeiten.

Wenn Sie für die Interoperabilität zwischen 
Pro Tools und einer Avid VENUE-Konsole 
VENUE Link verwenden, werden zusätzliche 
Optionen eingeblendet. Weitere Informationen 
hierzu finden Sie im VENUE Live Recording 
Guide.

Ausführliche Informationen hierzu finden Sie 
unter „Erstellen von Memory Locations“ auf 
Seite 837 und unter „Bearbeiten von 
Memory Locations“ auf Seite 843.
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Aufrufen von Memory 
Locations
Sie können Memory Locations über das 
Memory Locations-Fenster oder über den 
Ziffernblock aufrufen. Sie können Memory 
Location-Marker auch aufrufen, indem Sie sie 
in der Markers-Leiste anklicken.

So rufen Sie eine Memory Location auf:

1 Wählen Sie Window > Memory Locations, 
um das Memory Locations-Fenster anzuzeigen.

2 Wenn Sie eine Selection Memory Location 
aufrufen möchten, die einen Aufnahme- oder 
Wiedergabebereich beinhaltet, vergewissern 
Sie sich, dass Options > Link Timeline and Edit 

Selection ausgewählt ist.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie im Memory Locations-Fenster 
auf die gewünschte Memory Location, 
um diese aufzurufen.

• Wenn der Ziffernblockmodus auf „Classic“ 
eingestellt ist, geben Sie auf dem Ziffernblock 
die Nummer der Memory Location und 
anschließend einen Punkt (.) ein. 

• Wenn der Ziffernblockmodus auf „Transport“ 
oder „Shuttle“ eingestellt ist, geben Sie auf dem 
Ziffernblock einen Punkt (.), dann die Nummer 
der Memory Location und anschließend wieder 
einen Punkt (.) ein.

So rufen Sie einen Marker über die 
Markers-Leiste auf:

1 Wählen Sie View > Rulers > Markers, um die 
Markers-Leiste anzuzeigen.

2 Klicken Sie auf den gewünschten Marker. 
Der Playback-Cursor bewegt sich auf den 
Marker und alle mit diesem Marker 
gespeicherten General Properties-Einstellungen 
werden abgerufen.

Bearbeiten von Memory 
Locations
Memory Locations können umbenannt, bearbeitet, 
gelöscht sowie kopiert und eingefügt werden.

So benennen Sie eine Memory Location um:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie im Memory Locations-
Fenster auf die Memory Location, um das 
Edit Memory Location-Dialogfeld zu öffnen.

• Doppelklicken Sie in der Markers-Leiste auf den 
Marker, um das Edit Memory Location-
Dialogfeld zu öffnen und den Einfügepunkt 
an die Marker-Position zu verschieben.

• Klicken Sie in der Markers-Leiste bei gedrückter 
Windows-Taste (Windows) bzw. ctrl-Taste (Mac) 
auf den Marker, um das Edit Memory Location-
Dialogfeld zu öffnen, ohne den Einfügepunkt 
an die Marker-Position zu verschieben.

2 Geben Sie den neuen Namen für die Memory 
Location ein und klicken Sie dann auf OK.

Wenn Sie eine Memory Location über den 
Ziffernblock aufrufen, muss das Memory 
Locations-Fenster nicht geöffnet sein.

Auch wenn die Markers-Leiste nicht angezeigt 
wird, können Sie Marker über das Memory 
Locations-Fenster oder über den Ziffernblock 
aufrufen.
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So ändern Sie die mit einer Memory Location 
gespeicherten General Properties-Einstellungen:

1 Ändern Sie die Session-Einstellungen wie etwa 
Zoom-Einstellungen, Pre- und Post-Roll-Zeiten, 
spurspezifische Einstellungen wie Ein-
/Ausblendestatus und Darstellungshöhe sowie die 
Konfiguration von Edit- und Mix-Gruppen.

2 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie im Memory Locations-
Fenster auf die Memory Location, um das 
Edit Memory Location-Dialogfeld zu öffnen.

• Doppelklicken Sie in der Markers-Leiste auf den 
Marker, um das Edit Memory Location-
Dialogfeld zu öffnen und den Einfügepunkt 
an die Marker-Position zu verschieben.

• Klicken Sie in der Markers-Leiste bei gedrückter 
Windows-Taste (Windows) bzw. ctrl-Taste (Mac) 
auf den Marker, um das Edit Memory Location-
Dialogfeld zu öffnen, ohne den Einfügepunkt 
an die Marker-Position zu verschieben.

3 Wählen Sie im Memory Locations-Dialogfeld die 
General Properties-Einstellungen, die mit der 
Memory Location gespeichert werden sollen.

4 Geben Sie einen Namen für die Memory 
Location ein und klicken Sie dann auf OK.

So ändern Sie den Typ einer Memory Location:

1 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie im Memory Locations-
Fenster auf die Memory Location, um das Edit 
Memory Location-Dialogfeld zu öffnen.

• Doppelklicken Sie in der Markers-Leiste auf den 
Marker, um das Edit Memory Location-
Dialogfeld zu öffnen und den Einfügepunkt an 
die Marker-Position zu verschieben.

• Klicken Sie in der Markers-Leiste bei gedrückter 
Windows-Taste (Windows) bzw. ctrl-Taste (Mac) 
auf den Marker, um das Edit Memory Location-
Dialogfeld zu öffnen, ohne den Einfügepunkt an 
die Marker-Position zu verschieben.

2 Wählen Sie im Memory Location-Dialogfeld 
den gewünschten Memory Location-Typ 
(Marker, Selection oder None). 

3 Geben Sie einen Namen für die Memory 
Location ein und klicken Sie dann auf OK.

So ändern Sie die mit einer Memory Location 
gespeicherte Selektion:

1 Wählen Sie View > Rulers > Markers, um die 
Markers-Leiste anzuzeigen.

2 Selektieren Sie einen Bereich auf einer oder 
mehreren Spuren. 

3 Klicken Sie mit der rechten Maustaste 
(Windows) bzw. bei gedrückter ctrl-Taste (Mac) 
im Memory Locations-Fenster auf die zu 
ändernde Memory Location.

4 Geben Sie einen Namen für die Memory 
Location ein und klicken Sie dann auf OK.

So verschieben Sie einen Marker durch Ziehen:

 Ziehen Sie den Marker in der Markers-Leiste 
nach rechts oder links.

Wenn der Edit-Modus auf „Grid“ eingestellt ist, wird 
das gezogene Event automatisch entsprechend dem 
aktuellen Rasterwert positioniert. Im Spot-Modus 
öffnet sich das Spot-Dialogfeld.

So positionieren Sie einen Marker an einer 
neuen Position:

1 Aktivieren Sie ggf. Options > Link Timeline and 

Edit Selection.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie in einer der Zeitbasis-Leisten mit 
dem Selector-Tool auf die neue Position.
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• Klicken Sie in die Playlist einer beliebigen Spur. 
Um den Marker genau auf dem Startpunkt eines 
Clips zu positionieren, selektieren Sie den Clip mit 
dem Time Grabber-Tool.

3 Klicken Sie bei gedrückter Windows-Taste 
(Windows) bzw. ctrl-Taste (Mac) im Memory 
Locations-Fenster oder der Markers-Leiste auf 
die Marker Memory Location, die Sie neu 
positionieren möchten.

4 Geben Sie einen Namen für den Marker ein und 
klicken Sie auf OK.

Löschen von Memory 
Locations
Führen Sie einen der folgenden Schritte aus, 
um eine Memory Location zu löschen:

 Wählen Sie die Memory Location und 
wählen Sie dann aus dem Menü im Memory 
Locations-Fenster Delete Memory Location.

 Klicken Sie im Memory Locations-Fenster 
bei gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac) auf die entsprechende 
Memory Location.

Führen Sie einen der folgenden Schritte aus, 
um alle Memory Locations zu löschen:

 Wählen Sie aus dem Menü im Memory 
Locations-Fenster Delete All .

 Klicken Sie im Memory Locations-Fenster bei 
gedrückter Alt- und Umschalttaste (Windows) 
bzw. bei gedrückter Wahl- und Umschalttaste 
(Mac) auf eine beliebige Memory Location.

So löschen Sie einen Marker über die 
Markers-Leiste:

 Klicken Sie bei gedrückter Alt- (Windows) 
bzw. Wahltaste (Mac) auf den Marker.

Kopieren von Marker Memory 
Locations
So kopieren Sie einen Bereich mit mehreren Markern 
und fügen ihn an einer anderen Position ein:

1 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

2 Selektieren Sie durch Ziehen in der Tempo-
Leiste den Taktbereich, der die Marker enthält.

Wenn sich am Anfang einer Selektion ein Marker 
befindet, drücken Sie die Strg-Taste (Windows) 
bzw. Befehlstaste (Mac), um das Selector-Tool 
anzuzeigen.

3 Wählen Sie Edit > Copy.

4 Klicken Sie in der Markers-Leiste auf die Stelle, 
an der die Marker eingefügt werden sollen.

5 Wählen Sie Edit > Paste. Der Inhalt der 
Zwischenablage wird am gewählten 
Einfügepunkt eingefügt. Alle bis dahin dort 
vorhandenen Marker werden ersetzt.

So erweitern Sie die Edit-Selektion in einer 
Spur auf die Markers-Leiste:

1 Selektieren Sie mit dem Selector- oder Grabber-
Tool einen Spurabschnitt.

2 Klicken Sie bei gedrückter Umschalttaste auf 
die Markers-Leiste. 

Um die Markers-Leiste wieder aus der Selektion 
zu entfernen, klicken Sie erneut bei gedrückter 
Umschalttaste auf die Markers-Leiste.

So selektieren Sie sämtliche Marker in der 
Markers-Leiste:

 Doppelklicken Sie mit dem Selector-Tool in die 
Markers-Leiste.

Um eine Selektion in allen Dirigentenspuren 
vorzunehmen, halten Sie beim Ziehen die Alt-
Taste (Windows) bzw. die Wahltaste (Mac) 
gedrückt.
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Memory Locations-Fenster
Im Memory Locations-Fenster werden Memory 
Locations mit der ihnen zugewiesenen Nummer, dem 
Namen und Ansichtsfiltersymbolen aufgelistet. Über 
dieses Fenster können Sie Memory Locations 
aufrufen oder bearbeiten.

So rufen Sie im Memory Location-Fenster eine 
Memory Location auf:

 Klicken Sie auf die Memory Location.

Befehle und Optionen für 
Memory Locations
Im Menü des Memory Location-Fensters können 
Sie bestimmte Anzeige- und Sortieroptionen sowie 
Befehle zum Erzeugen und Löschen von Memory 
Locations auswählen.

View Filter-Untermenü. – enthält Befehle zum 
Ein- oder Ausblenden spezifischer Memory 
Location-Eigenschaften:

• Show Icons

• View Markers

• View Selections

• View Locations with Zoom Info

• View Locations with Pre/Post Roll Info

• View Locations with Track Show/Hide Info

• View Locations with Track Height Info

• View Locations with Group Info

• View Locations with Window Configuration 
Info 

• Show Markers Only

• Alle anzeigen

Memory Locations-Fenster mit Ansichtsfiltersymbolen

Wenn der Ziffernblockmodus auf „Classic“ 
eingestellt ist, geben Sie auf dem Ziffernblock 
die Nummer der Memory Location und 
anschließend einen Punkt (.) ein. Wenn der 
Ziffernblockmodus auf „Transport“ oder 
„Shuttle“ eingestellt ist, geben Sie auf dem 
Ziffernblock einen Punkt (.), dann die Nummer 
der Memory Location und anschließend wieder 
einen Punkt (.) ein.

Menü im Memory Locations-Fenster



Kapitel 36: Memory Locations 847

Show Main Counter. – wenn diese Einstellung 
ausgewählt ist, erscheint im Memory Locations-
Fenster eine Spalte, in der die Positionen der 
einzelnen Marker ausgehend von der Haupt-
Zeitskala sowie die Startzeiten der Selection 
Memory Locations angezeigt werden. Für General 
Property Memory Locations werden in dieser 
Spalte keine Informationen angezeigt.

Oben in der Haupt-Zeitskala-Spalte können 
Sie ein Popup-Menü öffnen, in dem Sie die Haupt-
Zeitskala ändern.

Show Sub Counter. – wenn diese Einstellung 
ausgewählt ist, erscheint im Memory Locations-
Fenster eine Spalte, in der die Positionen der 
einzelnen Marker ausgehend von der Sub-Zeitskala 
sowie die Startzeiten der Selection Memory 
Locations angezeigt werden. Für General Property 
Memory Locations werden in dieser Spalte keine 
Informationen angezeigt.

Oben in der Sub-Zeitskala-Spalte können Sie ein 
Popup-Menü öffnen, in dem Sie die Sub-Zeitskala 
ändern können.

Show Comments. – ist diese Option aktiviert, wird 
im Memory Locations-Fenster eine Spalte mit 
Anmerkungen zu jedem einzelnen Marker angezeigt.

Sort by Time. – ist diese Option aktiviert, werden die 
Marker entsprechend ihrer zeitlichen Abfolge in der 
Timeline sortiert. Danach werden Selection und 
General Properties Memory Locations in der 
Reihenfolge sortiert, in der sie erzeugt wurden.

Wenn Sort by Time deaktiviert ist, werden alle 
Memory Locations in der Reihenfolge ihrer 
Nummern sortiert.

New Memory Location. – wählen Sie diesen 
Befehl, wenn Sie eine neue Memory Location 
erzeugen möchten.

Edit <Name>. – öffnet das Edit Memory Location-
Dialogfeld für die ausgewählte Memory Location. 
Sie können auch im Memory Locations-Fenster 
auf eine Memory Location doppelklicken, um sie 
zu bearbeiten.

Clear <Name>. – löscht die ausgewählte Memory 
Location, aber nicht deren Slot. Nachfolgende 
Memory Locations werden nicht neu nummeriert.

Delete All. – löscht alle Memory Locations. 
Die nächste Memory Location, die hinzugefügt wird, 
erhält die Slot-Nummer 1.

Hauptzähler und Nebenzähler im Memory Locations-
Fenster

Memory Locations-Fenster, Auswahl der Haupt-
Zeitskala

Haupt-Zeitskala
Sub-Zeitskala

Anmerkungen im Memory Locations-Fenster

Klicken Sie im Memory Locations-Fenster bei 
gedrückter Alt- (Windows) bzw. Wahltaste 
(Mac) auf eine beliebige Memory Location, 
um sie zu löschen.
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Insert Slot Before <Name>. – fügt über der 
ausgewählten Memory Location eine neue leere 
Memory Location hinzu und nummeriert alle 
nachfolgenden Memory Locations neu.

Delete <Name> Slot. – löscht die ausgewählte 
Memory Location und nummeriert alle 
nachfolgenden Memory Locations neu.

Default To Marker. – wenn diese Einstellung 
ausgewählt ist, werden neue Memory Locations 
grundsätzlich als Marker erzeugt. Sie können 
jedoch im New Memory Location-Dialogfeld 
jederzeit einen anderen Typ für die neue Memory 
Location festlegen.

Auto-Name Memory Location. – wenn diese 
Einstellung ausgewählt ist, werden Memory 
Locations automatisch erzeugt, ohne dass das 
New Memory Location-Dialogfeld geöffnet wird. 
Wenn gleichzeitig die Default To Marker-Option 
ausgewählt ist, werden automatisch Marker Memory 
Locations erzeugt. Ansonsten ist der jeweils zuletzt 
erzeugte Memory Location-Typ („Marker“, 
„Selection“ oder „None“) ausschlaggebend dafür, 
welcher Memory Location-Typ als Nächstes 
automatisch erzeugt wird.

Ansichtsfiltersymbole
Wenn im Popup-Menü der Memory Locations 
„Show Icons“ ausgewählt ist, wird im Memory 
Locations-Fenster die Möglichkeit geboten, einen 
symbolbasierten Ansichtsfilter einzurichten, 
mit dem Memory Locations je nach ihren 
spezifischen Eigenschaften ein- oder ausgeblendet 
werden können. 

So blenden Sie Memory Locations mit einer 
bestimmten Eigenschaft ein bzw. aus:

 Klicken Sie auf das entsprechende Symbol.

Farben und Eigenschaften

Wenn ein Ansichtsfiltersymbol aktiviert ist, 
erscheint es farbig. Wenn es deaktiviert ist, 
erscheint es grau.

Wenn ein Symbol deaktiviert (abgeblendet) ist, 
werden alle Memory Locations mit der 
entsprechenden Eigenschaft ausgeblendet. 
Solange eine Memory Location jedoch weitere 
Eigenschaften enthält, für die ein Symbol aktiviert 
wurde, wird sie weiterhin angezeigt. 

Ein weiterer Vorteil des Ansichtsfilters besteht 
darin, dass er einen guten Überblick über die mit 
den einzelnen Memory Locations gespeicherten 
Eigenschaften (die durch eine Reihe von 
Symbolen angezeigt werden) bietet.

Memory Location-Ansichtsfiltersymbole

Marker Zoom 
Settings

Show/Hide
Track Heights

Fensterkonfiguration

Aktive GruppenPre- und Post-Roll
Selection 
Memory 
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Kapitel 37: Anordnen von Clips

Sobald Sie einen Clip erzeugt haben, erscheint dieser 
in der Clipliste. Von der Clipliste aus können Sie ihn 
auf eine Spur ziehen, um ihn einer bestehenden 
Anordnung von Clips hinzuzufügen, oder Sie 
können eine neue Spur erstellen und diese von 
Beginn an neu bestücken. An welcher Spurposition 
der Clip genau positioniert wird, hängt davon ab, ob 
der Edit-Modus auf „Shuffle“, „Slip“, „Spot“ oder 
„Grid“ eingestellt ist (siehe „Edit-Modi“ auf 
Seite 543).

Platzieren von Clips auf 
Spuren
So platzieren Sie einen Clip auf einer Spur:

1 Selektieren Sie die Clips, die Sie platzieren 
möchten, in der Clipliste.

2 Ziehen Sie die selektierten Clips von der 
Clipliste an eine Position in einer Spur. 

Beim Ziehen mehrerer Clips werden diese auf 
benachbarten Spuren von links nach rechts oder auf 
mehreren Spuren von oben nach unten platziert, 
abhängig von ausgewählten Timeline Drop Order-
Einstellung (siehe „Einstellen der Timeline-
Ablegereihenfolge“ auf Seite 850). Wenn Sie einen 
Stereo-Audioclip verschieben, muss dieser 
entweder auf einer Stereospur oder auf zwei 
Monospuren positioniert werden.

Clips werden entsprechend dem eingestellten Edit-
Modus positioniert:

• Im Shuffle-Modus werden vorhandene Clips auf 
einer Spur wenn nötig so verschoben, dass Platz 
für den neuen Clip entsteht.

• Im Spot-Modus werden Sie durch das Spot-
Dialogfeld aufgefordert, eine genaue Position 
für den verschobenen Clip einzugeben 
(siehe „Platzieren von Clips im Spot-Modus“ 
auf Seite 857). 

• Im Grid-Modus wird der verschobene 
Clip automatisch am nächstgelegenen 
Rasterpunkt ausgerichtet.

• Im Slip-Modus werden die Clips exakt 
dort platziert, wo sie in der Zielspur positioniert 
werden.

Sie können Clips in der Clipliste suchen, indem 
Sie die ersten Buchstaben des Namens des 
gewünschten Clips eingeben (siehe „Auswählen 
von Clips über die Tastatur“ auf Seite 275).

Sie können den Grid-Modus beim Ziehen eines 
Clips zeitweilig deaktivieren, indem Sie nach 
einem Mausklick die Strg- (Windows) bzw. die 
Befehlstaste (Mac) gedrückt halten.
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Arbeiten mit mehreren 
Elementen aus der Clipliste

Einstellen der Timeline-
Ablegereihenfolge
Mit der Option Timeline Drop Order im Cliplisten-
Popup-Menü wird festgelegt, ob Spuren, die aus der 
Clipliste gezogen werden, nacheinander auf einer 
einzelnen Spur positioniert oder über mehrere Spuren 
verteilt werden. Dies geschieht wie folgt:

Top to Bottom. – wenn diese Option aktiviert ist, 
werden Clips über mehrere Zielspuren oder neue 
Spuren verteilt (beim Ziehen auf den Bereich unter 
der letzten Spur oder auf die Tracks-Liste). 

Left to Right. – wenn diese Option aktiviert ist, 
werden Clips nacheinander auf einer einzelnen 
Zielspur oder einer neuen Spur platziert (beim 
Ziehen auf den Bereich unter der letzten Spur oder 
auf die Tracks-Liste).

So legen Sie die Ablegereihenfolge für die 
Clipliste fest:

 Wählen Sie Clip List > Timeline Drop Order und 
anschließend Top to Bottom oder Left to Right. 

Drag & Drop von mehreren 
Elementen aus der Clipliste

So ziehen Sie mehrere Elemente aus der Clipliste 
in mehrere neue Spuren und legen sie dort ab:

1 Wählen Sie im Cliplisten-Popup-Menü 
Timeline Drop Order > Top to Bottom.

2 Durchsuchen und sortieren Sie die Clipliste, 
um die Reihenfolge festzulegen, in der die 
Elemente abgelegt werden sollen. 

3 Wählen Sie in der Clipliste mehrere Elemente aus. 
Anschließend haben Sie folgende Möglichkeiten:

• Um neue Spuren zu erstellen und Elemente an 
einer bestimmten Position zu platzieren, legen 
Sie die Elemente an der Position im Bereich 
unter der letzten Spur ab. 

• Um neue Spuren zu erstellen und Elemente am 
Start der Session zu platzieren, legen Sie die 
Elemente auf der Tracks-Liste ab. 

So platzieren Sie mehrere Elemente über mehrere 
vorhandene Spuren:

1 Wählen Sie im Cliplisten-Popup-Menü 
Timeline Drop Order > Top to Bottom.

2 Wählen Sie in der Clipliste mehrere Elemente 
aus und legen Sie sie an der Zielposition in der 
Playlist einer kompatiblen Spur ab. Wenn der 
Cursor sich an einer kompatiblen Zielposition 
befindet, werden die Umrisse des Clips an dieser 
Position angezeigt. 

Neue Spuren nach dem Ablegen mehrerer Elemente 
aus der Clipliste im Modus „Top to Bottom“ für 
„Timeline Drop Order“
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So ziehen Sie mehrere Elemente aus der Clipliste 
in eine einzelne Spur und legen sie dort ab: 

1 Wählen Sie im Cliplisten-Popup-Menü 
Timeline Drop Order > Left to Right.

2 Durchsuchen und sortieren Sie die Clipliste, um 
die Reihenfolge festzulegen, in der die 
Elemente abgelegt werden sollen. 

3 Wählen Sie in der Clipliste mehrere Elemente aus. 
Anschließend haben Sie folgende Möglichkeiten:

• Um eine neue Spur zu erstellen und das erste 
Element an einer bestimmten Position 
einzufügen, legen Sie die Elemente an der 
Position im Edit-Fenster im Bereich unterhalb 
der letzten angezeigten Spur ab. 

• Soll eine neue Spur erstellt und das erste Element 
am Anfang der Session platziert werden, legen Sie 
die Elemente in der Tracks-Liste ab. 

• Um Elemente in einer bestehenden Spur 
zu platzieren, legen Sie sie in der Edit-Playlist 
der Spur ab. 

Gehören zu den selektierten Elementen Clips 
unterschiedlicher Art (etwa Audio und MIDI oder 
Clipgruppen und MIDI), werden Spuren der 
benötigten Typen erstellt und die Elemente werden in 
passenden Spuren abgelegt. Bei Elementen mit 
unterschiedlichen Formaten (Mono, Stereo usw.) 
werden ebenfalls neue Spuren mit den benötigten 
Formaten erstellt und die Clips in passenden Spuren 
abgelegt. 

Platzieren von Clips am 
Edit-Einfügepunkt
Sie können einen Clip aus der gleichen Spur, 
aus einer anderen Spur oder aus der Clipliste 
ziehen und seinen Start-, End- oder Sync-Punkt am 
Edit-Einfügepunkt ausrichten. Diese Technik ist in 
der Postproduktion nützlich, da Sie damit einen 
Edit-Selektionspunkt während der Wiedergabe 
oder des Anhaltens bestimmen und dann 
Soundeffekte schnell am Edit-Einfügepunkt 
platzieren können.

So platzieren Sie den Startpunkt eines Clips 
am Edit-Einfügepunkt:

1 Klicken Sie mit dem Selector-Tool in der Spur 
auf die zeitliche Position, an der der 
Clip beginnen soll. 

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie den Clip bei gedrückter Windows-Taste 
(Windows) bzw. ctrl-Taste (Mac) von der Clipliste 
oder einer anderen Spur auf die Zielspur.

• Wenn sich der Clip bereits auf der richtigen Spur 
befindet, klicken Sie bei gedrückter Windows-
Taste (Windows) bzw. ctrl-Taste (Mac) mit dem 
Time Grabber-Tool auf den Clip.

So platzieren Sie den Endpunkt eines Clips 
am Edit-Einfügepunkt:

1 Klicken Sie mit dem Selector-Tool in der 
Spur auf die zeitliche Position, an der der Clip 
enden soll. 

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie den Clip bei gedrückter Strg- und 
Windows-Taste (Windows) bzw. Befehls- und ctrl-
Taste (Mac) von der Clipliste oder einer anderen 
Spur auf die Zielspur.

Eine neue Spur, die erstellt wurde, indem bei „Timeline 
Drop Order“ der Modus „Left to Right“ ausgewählt und 
mehrere Elemente aus der Clipliste abgelegt wurden

In Pro Tools HD rasten Clips an Playhead 
anstelle des Edit-Einfügepunkts ein, wenn 
die Scrolling-Option auf „Center 
Playhead“ festgelegt ist.
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• Wenn sich der Clip bereits auf der Spur befindet, 
klicken Sie bei gedrückter Strg- und Windows-
Taste (Windows) bzw. Befehls- und ctrl-Taste 
(Mac) mit dem Time Grabber-Tool auf den Clip.

So platzieren Sie den Sync-Punkt eines Clips am 
Edit-Einfügepunkt:

1 Klicken Sie mit dem Selector-Tool in der Spur 
auf die zeitliche Position, an der sich der Sync-
Punkt des Clips befinden soll. 

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie den Clip bei gedrückter Umschalt- 
und Windows-Taste (Windows) bzw. Umschalt- 
und ctrl-Taste (Mac) von der Clipliste oder einer 
anderen Spur auf die Zielspur.

• Wenn sich der Clip bereits auf der Spur befindet, 
klicken Sie bei gedrückter Umschalt- und 
Windows-Taste (Windows) bzw. Umschalt- und 
ctrl-Taste (Mac) mit dem Time Grabber-Tool 
auf den Clip.

Ausrichten der Startpunkte 
von Clips
Der Start-, End- oder Sync-Punkt eines Clips kann 
am Startpunkt eines anderen Clips auf einer 
anderen Spur ausgerichtet werden.

So richten Sie den Startpunkt eines Clips am 
Startpunkt eines Clips auf einer anderen Spur aus:

1 Wählen Sie mit dem Time Grabber-Tool den 
Clip aus, an dem ausgerichtet werden soll, 
indem Sie darauf klicken.

2 Wenn die Scrolling-Option auf „Center Playhead“ 
(nur Pro Tools HD) eingestellt ist, verschieben Sie 
den Playhead zum Start des selektierten Clips. 
Weitere Hinweise finden Sie unter „Verschieben 
des Playhead“ auf Seite 417.

3 Sie haben folgende Möglichkeiten:

• Ziehen Sie einen Clip bei gedrückter Windows-
Taste (Windows) bzw. ctrl-Taste (Mac) von der 
Clipliste auf eine andere Spur.

• Wenn sich der Clip bereits auf der richtigen Spur 
befindet, klicken Sie bei gedrückter Windows-
Taste (Windows) bzw. ctrl-Taste (Mac) mit dem 
Time Grabber-Tool auf den Clip, den Sie 
verschieben möchten.

So richten Sie den Endpunkt eines Clips am 
Startpunkt eines Clips auf einer anderen Spur aus:

1 Wählen Sie mit dem Time Grabber-Tool den 
Clip aus, an dem ausgerichtet werden soll, 
indem Sie darauf klicken.

2 Wenn die Scrolling-Option auf „Center 
Playhead“ (nur Pro Tools HD) eingestellt ist, 
verschieben Sie den Playhead zum Start des 
selektierten Clips (siehe „Verschieben des 
Playhead“ auf Seite 417).

3 Sie haben folgende Möglichkeiten:

• Ziehen Sie einen Clip bei gedrückter Strg- und 
Windows-Taste (Windows) bzw. Befehls- und 
ctrl-Taste (Mac) von der Clipliste auf eine 
andere Spur.

• Wenn sich der Clip bereits auf der Spur befindet, 
klicken Sie bei gedrückter Strg- + Windows-
Taste (Windows) oder Befehls- + ctrl-Taste 
(Mac) mit dem Time Grabber-Tool auf den Clip, 
der verschoben werden soll.

So richten Sie den Sync-Punkt eines Clips am 
Startpunkt eines Clips auf einer anderen Spur aus:

1 Selektieren Sie mit dem Time Grabber-Tool den 
Clip, den Sie ausrichten möchten.

2 Wenn die Scrolling-Option auf „Center 
Playhead“ (nur Pro Tools HD) eingestellt ist, 
verschieben Sie den Playhead zum Start des 
selektierten Clips (siehe „Verschieben des 
Playhead“ auf Seite 417).

In Pro Tools HD werden Start-, End- 
und Sync-Punkt eines Clips am Playhead 
ausgerichtet, wenn die Scrolling-Option 
auf „Center Playhead“ eingestellt ist.
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3 Sie haben folgende Möglichkeiten:

• Ziehen Sie einen Clip bei gedrückter Umschalt- 
und Windows-Taste (Windows) bzw. Umschalt- 
und ctrl-Taste (Mac) von der Clipliste auf eine 
andere Spur.

• Wenn sich der Clip bereits auf der Spur befindet, 
klicken Sie bei gedrückter Umschalt- und 
Windows-Taste (Windows) bzw. Umschalt- und 
ctrl-Taste (Mac) mit dem Time Grabber-Tool auf 
den Clip, die verschoben werden soll.

Versetzen von Clips
Ein Clip oder eine Gruppe selektierter Clips (auf 
derselben Spur oder auf unterschiedlichen Spuren) 
kann mit dem Time Grabber-Tool an eine neue 
Position oder auf eine andere Spur versetzt 
werden. Diese Funktion ist besonders in der 
Postproduktion nützlich, wenn das Timing von 
Audiomaterial, beispielsweise Soundeffekte und 
Dialoge, genau an Musik-, Film- oder 
Videomaterial angepasst werden muss.

Das Versetzen von Clips wird davon beeinflusst, 
welcher der verschiedenen Edit-Modi („Shuffle“, 
„Slip“, „Spot“ oder „Grid“) gerade eingestellt ist 
(siehe „Edit-Modi“ auf Seite 543).

Verschieben von Clips im 
Shuffle-Modus
Im Shuffle-Modus können Sie Clips innerhalb einer 
Spur oder auf eine andere Spur verschieben, doch 
wird ihre Bewegungsfreiheit durch andere Clips 
eingeschränkt. Das heißt, wenn Sie auf einer Spur 
mehrere Clips platzieren, schließen diese 
unmittelbar aneinander an, ohne dass zwischen 
ihren Start- und Endpunkten Lücken entstehen. Sie 
können die Reihenfolge der Clips danach ändern. Es 
ist jedoch nicht möglich, sie voneinander zu trennen 
oder sie wie im Slip-Modus überlappen zu lassen. 
Wenn im Shuffle-Modus ein Clip am Anfang einer 
Spur eingefügt wird, werden alle nachfolgenden 
Clips um die Länge dieses Clips nach rechts 
verschoben.

So verschieben Sie Clips im Shuffle-Modus:

1 Aktivieren Sie den Shuffle-Modus (siehe „Edit-
Modi“ auf Seite 543).

2 Ziehen Sie einen Monoclip aus der Clipliste auf 
eine leere Spur. Der Clip rastet automatisch am 
Anfang der Spur ein.

3 Ziehen Sie einen zweiten Clip aus der Clipliste 
und platzieren Sie ihn im mittleren Bereich der 
gleichen Spur. Der Startpunkt des zweiten Clips 
rastet automatisch am Endpunkt des ersten 
Clips ein.

4 Ziehen Sie den zweiten Clip mit dem Time 
Grabber-Tool an den Anfang der Spur.

Pro Tools „vertauscht“ die Position der beiden 
Clips. Der zweite Clip steht nun an erster Stelle, 
doch sind beide Clips immer noch unmittelbar 
miteinander verbunden.

5 Experimentieren Sie weiter mit dem Shuffle-
Modus, indem Sie zusätzliche Clips auf die 
Spur ziehen und sie neu anordnen.

Sie können die Kopie eines Clips an eine 
andere Position oder auf eine andere Spur 
versetzen, indem Sie während des Ziehens 
die Alt-Taste (Windows) bzw. die 
Wahltaste (Mac) gedrückt halten.

Um die zeitliche Position eines Clips beim 
Ziehen auf eine andere Spur beizubehalten, 
drücken Sie die Windows-Taste (Windows) 
bzw. die ctrl-Taste (Mac).
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Gesperrte Clips (siehe „Sperren von Clips“ auf 
Seite 864) sowie alle Clips, die auf einen gesperrten 
Clip folgen, werden nicht mitbewegt, wenn 
benachbarte Clips im Shuffle-Modus verschoben 
werden. Falls nicht genug Platz vorhanden ist, 
um einen Clip oder ein Clip-Duplikat vor einem 
gesperrten Clip zu platzieren, wird der 
Einfügebereich deaktiviert.

Wenn Sie einen Clip im Slip-Modus positioniert 
haben und dann in den Shuffle-Modus wechseln, 
behält Pro Tools das relative Timing und die 
Position des im Slip-Modus platzierten Clips 
sowie eventuell vorhandene Lücken zwischen 
diesem und den benachbarten Clips bei.

Verschieben von Clips auf 
mehreren Spuren sowie von 
Mehrkanal-Clips im Shuffle-
Modus
Auch eine Selektion, die sich über mehrere Spuren 
hinweg erstreckt oder aus Mehrkanalspuren besteht, 
kann im Shuffle-Modus verschoben werden. Anders 
als beim Verschieben von Clips auf eine einzelne 
Spur werden alle teilweise selektierten Clips 
ausgeschnitten und zusammen mit den ausgewählten 
Clips verschoben. Damit wird nur das Material 
beibehalten, das dem weggezogenen Clip entspricht.

Verschieben von Clips mit 
den Grabber-Tools
Mit den Grabber-Tools können Sie einen oder 
mehrere Clips oder die Edit-Selektion an eine 
andere Position verschieben. Die Grabber-Tools 
schneiden die Selektion aus und fügen sie an der 
neuen Position ein. 

So verschieben Sie einen oder mehrere Clips oder 
die Edit-Selektion mit einem der Grabber-Tools:

1 Nehmen Sie eine Selektion vor.

2 Ziehen Sie die Selektion mit einem der 
Grabber-Tools („Time“, „Separation“ oder 
„Object“) an die neue Position.

Bei bestimmten Workflows muss der Shuffle-
Modus ausgeschlossen werden, um 
sicherzustellen, dass die zeitliche Abstimmung 
der Clips beim Editieren erhalten bleibt. 
Mit „Shuffle Lock“ wird verhindert, dass Sie 
versehentlich den Shuffle-Modus aufrufen, 
indem alle wichtigen Befehle und Schalter 
der Bedienoberfläche für den Shuffle-Modus 
deaktiviert werden. Weitere Informationen 
finden Sie unter „Sperren des Shuffle-Modus“ 
auf Seite 544.

Das Verschieben eines Clips im Shuffle-Modus führt 
zum Ausschneiden des Kanals

Halten Sie die Alt-Taste (Windows) bzw. 
die Wahltaste (Mac) gedrückt, wenn Sie 
die Selektion mit dem Grabber-Tool 
anklicken und ziehen, um sie nicht 
auszuschneiden, sondern zu kopieren.
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Time Grabber und 
Object Grabber
Beim Verschieben von Audiodaten überschreiben 
die Time Grabber- und Object Grabber-Tools nur 
die Audiodaten auf der Zielspur.

Separation Grabber
Der Separation Grabber ersetzt den gesamten 
selektierten Bereich auf der Timeline der Zielspur. 

Einfügen am vorherigen oder 
nächsten Clip einer Spur
Ein Clip oder eine Edit-Selektion mit einem oder 
mehreren Clips auf derselben Spur oder auf 
mehreren Spuren kann am Ende des vorherigen 
Clips oder am Anfang des nächsten Clips 
ausgerichtet werden. Dies ist beim „Butt Splicing“ 
benachbarter Clips auf einer Spur nützlich.

So richten Sie einen Clip an dem vorherigen Clip 
einer Spur aus:

1 Sie haben folgende Möglichkeiten:

• Selektieren Sie mit dem Time Grabber-Tool 
einen Clip.

• Selektieren Sie mit dem Selector-Tool 
einen Bereich auf einer Spur, der komplette 
Clips enthält. Die Clips müssen nicht 
nebeneinander liegen.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Snap To > Previous. 

• Klicken Sie mit der rechten Maustaste auf den 
Clip oder die Edit-Selektion und wählen Sie 
Snap to Previous.

Der selektierte Clip wird an dem vorherigen Clip 
der Spur ausgerichtet, sodass die beiden Clips per 
„Butt-Splicing“ verbunden sind.

So richten Sie einen Clip am nächsten Clip einer 
Spur aus:

1 Sie haben folgende Möglichkeiten:

• Selektieren Sie mit dem Time Grabber-Tool 
einen Clip.

• Selektieren Sie mit dem Selector-Tool 
einen Bereich auf einer Spur, der komplette 
Clips enthält. Die Clips müssen nicht 
nebeneinander liegen.

Verschieben einer Selektion mit dem Time Grabber

Verschieben einer Selektion mit dem Separation Grabber
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2 Sie haben folgende Möglichkeiten:

• Wählen Sie Edit > Snap To > Next. 

• Klicken Sie mit der rechten Maustaste auf den 
Clip oder die Edit-Selektion und wählen Sie 
Snap to Next.

Der selektierte Clip wird am nächsten Clip der 
Spur ausgerichtet, sodass die beiden Clips per 
„Butt-Splicing“ verbunden sind.

Verschieben von Clips im 
Slip-Modus
Im Slip-Modus können Clips mit dem Time Grabber-
Tool beliebig innerhalb einer Spur oder auf andere 
Spuren verschoben werden. Dieser Modus 
ermöglicht es, einen Clip so zu platzieren, dass 
zwischen ihm und angrenzenden Clips auf der Spur 
Lücken entstehen. Wenn die Spur wiedergegeben 
wird, bleiben diese Lücken stumm. Ein Clip kann so 
verschoben werden, dass er einen anderen Clip 
teilweise oder vollständig überlagert.

So verschieben Sie Clips im Slip-Modus:

1 Aktivieren Sie den Slip-Modus (siehe „Edit-
Modi“ auf Seite 543).

2 Ziehen Sie einen Clip aus der Clipliste auf eine 
leere Spur.

3 Ziehen Sie einen zweiten Clip aus der Clipliste 
und platzieren Sie ihn im mittleren Bereich der 
gleichen Spur. Der zweite Clip wird an der 
Stelle positioniert, an der Sie die Maustaste 
loslassen. Er wird nicht wie im Shuffle-Modus 
am ersten Clip ausgerichtet.

4 Ziehen Sie die Clips an verschiedene Positionen 
innerhalb der Spur, um ein Gefühl für das 
Verschieben von Clips im Slip-Modus zu 
bekommen. Platzieren Sie den zweiten Clip so, 
dass er geringfügig mit dem ersten überlappt. 
Hören Sie sich das Ergebnis an.

Ausrichten eines Clips am nächsten Clip einer Spur

Die Snap To-Befehle können auch bei einer Edit-
Selektion verwendet werden, die mehrere Clips 
auf einer oder mehreren Spuren enthält.
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Platzieren von Clips im Spot-
Modus
Der Spot-Modus ist in Sessions hilfreich, in denen 
Sie Clips anhand einer der Zeitskalen genau 
platzieren möchten. Dies ist bei der Postproduktion 
nützlich. Im Spot-Modus können Sie einen Clip 
anhand eines SMPTE-Frames oder einer 
Taktposition, anhand einer von außen eingespielten 
Timecode-Adresse oder unter Verwendung des 
Zeitstempels des Clips platzieren.

So platzieren Sie einen Clip im Spot-Modus:

1 Aktivieren Sie den Spot-Modus (siehe „Edit-
Modi“ auf Seite 543).

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie einen Clip aus der Clipliste bzw. 
Audiodateien oder Sessions aus einem 
Workspace-Browser auf eine vorhandene Spur. 

• Klicken Sie mit dem Time Grabber-Tool auf einen 
bereits bestehenden Clip innerhalb der Spur.

3 Wählen Sie im Spot-Dialogfeld ein Zeitformat 
aus dem Time Scale-Popup-Menü.

Sämtliche Felder des Spot-Dialogfelds werden in 
der gewählten Zeitskala angezeigt.

4 Wenn die Zeitskala auf „Timecode“ eingestellt 
ist, aktivieren Sie die Use Subframes-Option, 
damit in den Feldern Subframes angezeigt 
werden. Dadurch wird eine noch genauere 
Positionierung möglich.

5 Sie haben folgende Möglichkeiten:

• Klicken Sie in das Feld für den Start-, Sync- 
oder Endpunkt und geben Sie eine neue Position 
ein. Wird die Position eines dieser Punkte 
geändert, verschieben sich automatisch auch die 
anderen.

• Klicken Sie auf einen der nach oben zeigenden 
Pfeile neben „Original Time Stamp“ oder „User 
Time Stamp“, um die entsprechenden Werte in 
das aktuell ausgewählte Feld zu übertragen.

• Wenn Sie eine externe Quelle für den SMPTE-
Timecode verwenden, klicken Sie auf den nach 
unten weisenden Pfeil neben der Current 
Timecode-Anzeige (oder drücken Sie die Enter-
Taste auf dem Ziffernblock), um die eingehende 
Timecode-Adresse zu übernehmen.

6 Klicken Sie auf OK. Der Clip wird an die für 
seinen Start-, End- oder Sync-Punkt festgelegte 
neue Position verschoben.

Wenn für einen Clip kein Sync-Punkt festgelegt 
wurde, hat das Sync Point-Feld im Spot-Dialogfeld 
die gleiche Funktion wie das Start-Feld.

Wenn Sie VITC verwenden und noch schneller 
arbeiten möchten, können Sie mit dem Auto-
Spot Clips-Befehl Clips mit dem Time 
Grabber-Tool auf dem aktuellen SMPTE-
Frame platzieren. Weitere Informationen 
finden Sie unter „Clips automatisch 
positionieren“ auf Seite 1226.

Weitere Informationen zur Verwendung 
von SMPTE mit Pro Tools finden Sie unter 
Kapitel 50: „Synchronisation in Pro Tools“.

Spot-Dialogfeld
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Einfügen von Clips über Befehle 
mit der rechten Maustaste
Sie können die Clips einer Spur über Befehle 
mit der rechten Maustaste und eine 
Tastenkombination einfügen.

So fügen Sie einen Clip an einer Selektion ein:

1 Klicken Sie mit dem Selector-Tool in der Spur an 
die Stelle, an der Sie den Clip einfügen möchten, 
oder nehmen Sie in der Spur durch Ziehen mit 
der Maus eine Selektion vor.

2 Klicken Sie bei gedrückter Strg- (Windows) bzw. 
Befehlstaste (Mac) mit der rechten Maustaste auf 
den Clip und wählen Sie aus dem Popup-Menü 
eine der folgenden Optionen aus:

• Start des Clips zum Start der Auswahl 

verschieben 

• Sync-Punkt des Clips zum Start der Auswahl 

verschieben 

• Ende des Clips zum Start der Auswahl 

verschieben 

Zeitstempel von Clips
Wenn ein Clip erzeugt wird, erhält er entsprechend 
der für die Session festgelegten SMPTE-Startzeit 
einen Zeitstempel. Dieser ursprüngliche Zeitstempel 
(Original Time Stamp) wird dauerhaft mit dem Clip 
gespeichert und kann nicht geändert werden. Wenn 
ein Clip verschoben wurde, kann er über das Spot-
Dialogfeld problemlos an seine Ursprungsposition 
zurückbewegt werden.

Wenn der Original Time Stamp-Wert eines Clips 
gesetzt ist, wird diese Position auch verwendet, um den 
User Time Stamp-Wert des Clips festzulegen.

Anders als der Original Time Stamp-Wert kann der 
User Time Stamp-Wert über den Time Stamp-Befehl 
im Cliplisten-Popup-Menü neu festgelegt werden 
(siehe „Zeitstempelfunktion“ auf Seite 1226). 

Zeitstempel im Workspace

Original Time Stamp- und User Time Stamp-
Werte werden in Spalten von Workspace-
Browsern angezeigt. 

Zeitstempel und Matches-Funktion

Clips mit identischen User Time Stamp-Werten 
werden im Matches-Untermenü im Kontextmenü 
zusammen angezeigt, wenn die Takes abgehört 
werden (siehe „Selektieren alternativer Takes auf 
einer Spur“ auf Seite 472).

Verschieben von Clips im 
Grid-Modus
Der Grid-Modus bietet mehrere nützliche 
Funktionen zum Versetzen und Verschieben von 
Clips in Spur-Playlists. Dieser Modus ist 
besonders geeignet, wenn Sie Clips in genauen 
Intervallen anordnen wollen, wie beim Arbeiten 
mit einer Session, die auf einem Taktraster basiert. 
Das Raster hängt von der gewählten Haupt-
Zeitskala ab und kann auf Frames, Takten und 
Schlägen (Bar/Beat), Minuten oder Sekunden 
sowie auf Samples basieren. 

Außerdem kann der Grid-Modus als absoluter oder 
relativer Modus verwendet werden. Diese Modi 
bestimmen, wie das Raster verwendet wird (siehe 
„Absolute Grid-Modus und Relative Grid-Modus“ 
auf Seite 859).

In früheren Versionen von Pro Tools konnten 
Sie mit dem Grabber-Tool mit der rechten 
Maustaste in einen Clip klicken, um diesen an 
einer Selektion einzufügen.

Um beim Ziehen eines Clips den Grid-Modus 
zeitweilig zu deaktivieren und in den Slip-Modus 
zu wechseln, halten Sie die Strg-Taste (Windows) 
bzw. die Befehlstaste (Mac) gedrückt.
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Einstellen eines Rasters
Wenn in den Display-Voreinstellungen die Option 
„Draw Grid in Edit Window“ aktiviert ist, erscheinen 
im Edit-Fenster vertikale Rasterlinien.

Um die Rasterlinien im Edit-Fenster zu aktivieren 
oder zu deaktivieren, können Sie auch auf den 
Namen der Zeitbasis-Leiste klicken, wenn dieser 
hervorgehoben wird.

Festlegen des Rasterwerts
Der Rasterwert beeinflusst nicht nur die Platzierung 
von Clips, sondern auch die Timeline- und Edit-
Selektion sowie die Wirkung des Befehls Clip > 
Quantize to Grid.

So stellen Sie den Rasterwert ein:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie aus dem Menü View > Main Counter 
die Zeitskala, die Sie für den Rasterwert 
verwenden möchten.

• Um die Haupt-Zeitskala beizubehalten und ein 
anderes Zeitformat für das Raster zu verwenden, 
deaktivieren Sie im Edit-Fenster im Grid-Popup-
Menü die Follow Main Timebase-Option.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie aus dem Popup-Menü „Grid Value“ 
den Zeitwert für die Rastergrenzen.

• Um ein Raster festzulegen, das auf den Markern, 
Selektionen und Clipgrenzen einer Session 
basiert, wählen Sie aus dem Grid Value-Popup-
Menü die Clips/Markers-Option.

Absolute Grid-Modus und 
Relative Grid-Modus
Der Grid-Modus kann als absoluter oder relativer 
Modus verwendet werden. 

 Im Absolute Grid-Modus rastet der Startpunkt des 
Clips beim Ziehen automatisch an den 
nächstgelegenen Rastergrenzen ein. Wenn der 
Startpunkt eines Clips zwischen Schlägen liegt und 
das Raster auf Viertelnoten gesetzt ist, rastet der 
Startpunkt des Clips bei der nächstgelegenen 
Viertelnote (aktueller absoluter Grid-Wert) ein. 

 Im Relative Grid-Modus werden Clips nach 
Raster- (oder Nudge-Einheiten) verschoben. Wenn 
der Startpunkt eines Clips zwischen Schlägen liegt 
und das Raster auf eine Viertelnote gesetzt ist, 
werden Clips in Viertelnoten-Schritten verschoben, 
wodurch die relative Position des Clips zum nächsten 
Beat erhalten bleibt.

So wählen Sie den absoluten oder relativen 
Grid Modus:

 Klicken Sie auf den Selektor für den Grid-Modus 
und wählen Sie Absolute Grid oder Relative Grid.

So platzieren oder verschieben Sie einen Clip im 
Grid-Modus:

1 Konfigurieren Sie den Rasterwert (siehe 
„Festlegen des Rasterwerts“ auf Seite 859).

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie einen Clip aus der Clipliste auf eine 
vorhandene Spur. 

• Ziehen Sie mit dem Time Grabber-Tool einen 
bereits auf der Spur vorhandenen Clip an eine 
andere Position.

Der Startpunkt des Clips rastet an der 
nächstgelegenen Rastergrenze ein. Wenn für den 
Clip ein Sync-Punkt festgelegt wurde, rastet dieser 
an der Rastergrenze ein.Popup-Menü „Grid Value“, „Bars|Beats“ ist ausgewählt

Um beim Ziehen eines Clips den Grid-Modus 
zeitweilig zu deaktivieren und in den Slip-Modus 
zu wechseln, halten Sie die Strg-Taste (Windows) 
bzw. die Befehlstaste (Mac) gedrückt.



Pro Tools-Referenzhandbuch860

Ersetzen von Audioclips
(Nur Pro Tools HD)

Ersetzen Sie mithilfe der Replace Clip-Funktion 
mehrere Instanzen eines Audioclips in einer Playlist 
durch einen anderen Clip. Diese Funktion ist 
beispielsweise dann hilfreich, wenn Sie einen Clip 
mit einem bestimmten Soundeffekt, 
Hintergrundgeräuschen oder einer bestimmten 
Atmosphäre innerhalb einer Session mehrmals 
verwendet haben und später beschließen, diesen an 
einer oder allen Positionen durch einen anderen Clip 
zu ersetzen.

Auch bei Musikproduktionen kann beispielsweise 
ein bestimmter Loop oder ein Sample (wie etwa ein 
Schlagzeug-Beat) durch einen anderen ersetzt 
werden. Wenn das Tempo eines Abschnitts oder der 
Session bekannt ist, können Sie die Rohfassung eines 
Songs mit „vorläufigen“ Clips einer bestimmten 
Länge arrangieren und diese später durch gleich 
lange „endgültige“ Clips ersetzen.

So ersetzen Sie Clips per Drag & Drop:

1 Selektieren Sie in der Playlist einer Spur den 
Clip, den Sie ersetzen möchten. Die Selektion 
kann gegebenenfalls auch über den Endpunkt 
des Clips hinausreichen, um Material eines 
Austauschclips einzuschließen, der länger ist 
als der ursprüngliche Clip.

2 Ziehen Sie den Austauschclip bei gedrückter 
Umschalt- und Strg-Taste (Windows) bzw. 
Umschalt- und Befehlstaste (Mac) aus der 
Clipliste auf den selektierten Clip. Das Replace 
Clip-Dialogfeld wird geöffnet.

3 Konfigurieren Sie die Einstellungen im Replace 
Clip-Dialogfeld (siehe „Optionen im Replace 
Clip-Dialogfeld“ auf Seite 861).

4 Klicken Sie auf OK.

Ersetzen von Clips aus 
der Clipliste
Der Replace Clips-Befehl ist auch im Cliplisten-
Menü verfügbar. Stellen Sie beim Verwenden 
dieses Befehls sicher, dass ein Clip in einer 
Spur sowie ein anderer (Austausch-)Clip in 
der Clipliste selektiert ist. 

So ersetzen Sie Clips über das Cliplisten-Menü:

1 Selektieren Sie einen zu ersetzende Clip auf 
einer Spur. 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie in der Clipliste mit der rechten 
Maustaste auf den Austauschclip und wählen 
Sie aus dem Popup-Menü Replace Clips.

• Wählen Sie den Austauschclip in der Clipliste aus 
und wählen Sie dann aus dem Cliplisten-Menü 
Replace Clips. (Wenn die Einstellung Clip List 

Selection Follows Edit Selection aktiviert ist, 
klicken Sie bei gedrückter Strg-Taste (Windows) 
bzw. Befehlstaste (Mac) auf den selektierten Clip, 
um ihn zu deaktivieren. Dann klicken Sie bei 
gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf den Austauschclip, um ihn 
zu aktivieren, und wählen aus dem Cliplisten-
Menü Replace Clips.)

3 Konfigurieren Sie die Einstellungen im Replace 
Clip-Dialogfeld (siehe „Optionen im Replace 
Clip-Dialogfeld“ auf Seite 861).

4 Klicken Sie auf „OK“.
Halten Sie die Umschalt- und Strg-Taste 
(Windows) bzw. die Umschalt- und 
Befehlstaste (Mac) gedrückt und ziehen 
Sie einen Clip aus der Clipliste auf einen 
nicht selektierten Clip einer Spur, um das 
Replace Clip-Dialogfeld zu öffnen, ohne 
vorher eine Selektion vorzunehmen.



Kapitel 37: Anordnen von Clips 861

Replace Clip-Befehl und 
Mehrkanalspuren
Mit dem Replace Clip-Befehl können auch 
Mehrkanalclips aus der Clipliste auf 
Mehrkanalspuren gezogen werden, vorausgesetzt, 
sie haben das gleiche Kanalformat. Sie können 
beispielsweise einen selektierten Stereoclip auf 
einer Stereo-Audiospur durch einen anderen 
Stereoclip aus der Clipliste ersetzen. Sie können sie 
jedoch nicht durch zwei Mono-Audioclips ersetzen. 
Außerdem können auch Clips in mehreren 
Monospuren nicht durch Mehrkanal-Clips ersetzt 
werden.

Optionen im Replace Clip-
Dialogfeld

Das Replace Clip-Dialogfeld stellt Ihnen folgende 
Optionen zur Verfügung:

Replace: Original Clip Only. – es wird 
ausschließlich der selektierte Clip durch den aus 
der Clipliste gezogenen Clip ersetzt.

Replace: All Instances of the Original Clip. – alle 
Instanzen des selektierten Clips, die den unter „On“ 
angegebenen Kriterien entsprechen, werden durch 
einen Austauschclip aus der Clipliste ersetzt.

• Mit On: This Track werden alle Clips ersetzt, die 
den unter „Match“ angegebenen Kriterien 
entsprechen und sich auf derselben Spur wie der 
selektierte Clip befinden.

• Mit On: All Tracks werden alle Clips ersetzt, 
die den unter „Match“ angegebenen Kriterien 
entsprechen, egal auf welcher Spur sie 
sich befinden.

• Mit On: Within the Selection werden Clips 
ersetzt, die den unter „Match“ angegebenen 
Kriterien entsprechen und sich in der aktuellen 
Selektion befinden.

Replace: All Clips that Match Original Clip's. – 
alle Clips, die den unter „Match“ und „On“ 
angegebenen Kriterien entsprechen, werden durch 
den Clip aus der Clipliste ersetzt. 

• Mit Start Position werden alle Clips ersetzt, 
die den gleichen ursprünglichen Startpunkt 
haben wie der selektierte Clip. Dies schließt 
auch Clips ein, die beim Trimmen von 
Endpunkten automatisch erzeugt wurden.

• Mit End Position werden alle Clips ersetzt, 
die den gleichen ursprünglichen Endpunkt 
haben wie der selektierte Clip. Dies schließt 
auch Clips ein, die beim Trimmen von 
Startpunkten automatisch erzeugt wurden.

• Mit Name werden alle Clips ersetzt, die aus der 
gleichen Audiodatei stammen und mit dem 
gleichen Namen umbenannt wurden.

Replace Clip-Dialogfeld
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• Mit On: This Track werden alle Clips ersetzt, die 
den unter „Match“ angegebenen Kriterien 
entsprechen und sich auf derselben Spur wie der 
selektierte Clip befinden.

• Mit On: All Tracks werden alle Clips ersetzt, 
die den unter „Match“ angegebenen Kriterien 
entsprechen, egal auf welcher Spur sie 
sich befinden.

• Mit On: Within the Selection werden Clips 
ersetzt, die den unter „Match“ angegebenen 
Kriterien entsprechen und sich in der aktuellen 
Selektion befinden.

Bei der Ermittlung des zu ersetzenden Clips werden 
alle unter „Match“ angegebenen Kriterien 
herangezogen. Wenn Sie beispielsweise unter 
„Match“ die Kriterien „Start Position“ und „End 
Position“ auswählen, werden alle Clips ersetzt, 
die aus derselben Ursprungs-Audiodatei stammen 
wie der selektierte Clip und den gleichen Start- und 
Endpunkt wie dieser besitzen.

Fit Clip Using The: Original Clip Length. – wenn 
der Austauschclip kürzer ist als der selektierte 
Clip, wird er in der Playlist platziert und das 
restliche Audiomaterial des selektierten Clips wird 
aus der Spur entfernt. 

Wenn der Austauschclip länger ist als der selektierte 
Clip, wird er in der Playlist platziert und auf die 
Länge des selektierten Clips getrimmt.

Fit Clip Using The: Original Selection Length. – 
wenn die Selektion aus der Playlist über den 
selektierten Clip hinausreicht, wird der Austauschclip 
(sofern er länger ist als der selektierte Clip) auf die 
Länge der Selektion getrimmt.

Fit Clip Using The: Replacement Clip Length. – 
der Austauschclip wird, unabhängig von der Länge 
des selektierten Clips oder der Selektion, 
unverändert eingefügt.

Sync-Punkte
Im Grid- und Spot-Modus kann die Platzierung von 
Clips durch die Definition eines Sync-Punktes 
erfolgen. Sync-Punkte können Audio-, MIDI- und 
Videoclips sowie Clipgruppen hinzugefügt werden. 
Sync-Punkte werden verwendet, um einen 
bestimmten Punkt innerhalb eines Clips am Raster 
oder an einer bestimmten SMPTE- bzw. Bar/Beat-
Position auszurichten. Diese Möglichkeit wird 
besonders im Film- und Videobereich benötigt, 
um Musik und Soundeffekte präzise zu platzieren.

Angenommen, ein Audioclip enthält das Zuschlagen 
einer Tür, jedoch auch das Quietschen der Türangeln 
vor dem Zuschlagen sowie den Nachhall des 
Türknalls. Mithilfe eines Sync-Punkts für das 
Geräusch des Zuschlagens im Clip können Sie dieses 
einer bestimmten Zeit in der Session zuordnen.

So legen Sie einen Sync-Punkt in einem Clip fest:

1 Aktivieren Sie den Slip-Modus (siehe „Edit-
Modi“ auf Seite 543).

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Selector-Tool im Clip auf 
die Stelle, an der Sie den Sync-Punkt festlegen 
möchten.

• Halten Sie die Nach-unten-Pfeiltaste gedrückt 
und spielen Sie das Material ab. 

3 Wählen Sie Clip > Identify Sync Point. 
Ein kleiner nach unten weisender Pfeil 
erscheint am unteren Rand des Clips und 
die Position des Sync-Punkts wird mit einer 
vertikalen, hellgrauen Linie markiert.

Sync-Punkt
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So ändern Sie die Position eines Sync-Punkts:

 Klicken Sie mit dem Selector-Tool auf einen 
Punkt in einem Clip und wählen Sie Clip > 

Identify Sync Point. Die neue Position wird 
als Sync-Punkt für den Clip festgelegt.

Entfernen von Sync-Punkten

Sie haben folgende Möglichkeiten, um einen Sync-
Punkt zu entfernen:

 Selektieren Sie den ganzen Clip und wählen Sie 
Clip > Remove Sync Point.

 Wählen Sie das Time Grabber-Tool aus und 
klicken Sie dann bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) auf den Sync-
Punkt, um ihn zu löschen.

Anzeigen von Sync-Punkten
Sync-Punkte in Audioclips können ein- oder 
ausgeblendet werden.

So deaktivieren Sie die Anzeige von Sync-Punkten 
in Audioclips:

 Deaktivieren Sie View > Clip > Sync Point.

So aktivieren Sie die Anzeige von Sync-Punkten in 
Audioclips:

 Wählen Sie View > Clip > Sync Point. 

Ziehen von Sync-Punkten
Sync-Punkte können an eine andere Position im 
Audioclip gezogen werden. 

So legen Sie den Sync-Punkt durch Ziehen fest:

1 Wenn der Sync-Punkt am aktuellen Rasterwert 
ausgerichtet werden soll, aktivieren Sie den 
Grid-Modus (siehe „Edit-Modi“ auf Seite 543).

2 Wählen Sie das Time Grabber-Tool.

3 Ziehen Sie den Sync-Punkt an eine neue Position.

Scrubben von Sync-Punkten
Obwohl die Anzeige einer Audiowellenform 
durchaus eine gute Methode zum Festlegen von 
Sync-Punkten ist, ist die gewünschte Position im 
Audiomaterial in der Waveform-Darstellung 
möglicherweise nicht leicht erkennbar. Durch 
Scrubben beim Verschieben des Sync-Punkts über 
eine Audiowellenform können Sie das 
Audiomaterial abhören, um die genaue Position 
für den Sync-Punkt zu ermitteln.

So scrubben Sie beim Ziehen des Sync-Punkts:

1 Wenn der Sync-Punkt nach dem Scrubben 
am aktuellen Rasterwert ausgerichtet werden 
soll, stellen Sie den Edit-Modus auf „Grid“ ein 
(siehe „Edit-Modi“ auf Seite 543).

2 Aktivieren Sie das Scrubber-Tool.

3 Ziehen Sie den Sync-Punkt an eine neue 
Position. Während des Verschiebens wird 
im Audiomaterial gescrubbt.

Sie können den Sync-Punkt auch durch 
Ziehen verschieben (siehe „Ziehen von Sync-
Punkten“ auf Seite 863).

Scrubben von Sync-Punkten (Cursor)
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Shift-Befehl
Verwenden Sie den Shift-Befehl, um Material auf 
einer Spur um einen bestimmten Wert nach vorne 
oder hinten zu verschieben. Der Shift-Befehl kann 
auf Selektionen, Clips, MIDI-Noten, MIDI-
Controller-Daten und Automation-Breakpoints 
angewendet werden.

So verschieben Sie eine Selektion oder einen Clip 
mit dem Shift-Befehl:

1 Selektieren Sie mit dem Selector- oder 
Time Grabber-Tool das Spurmaterial, 
das Sie verschieben möchten. Das selektierte 
Material kann sich dabei auch auf mehreren 
Spuren befinden.

2 Wählen Sie Edit > Shift. Legen Sie im Shift-
Dialogfeld fest, ob die Daten nach vorne bzw. 
links (Earlier) oder nach hinten bzw. rechts 
(Later) verschoben werden sollen.

3 Klicken Sie in eines der Timebase-Eingabefelder, 
um festzulegen, um welchen Wert das Material 
verschoben werden soll. Durch Eingabe eines 
Wertes in ein Timebase-Feld werden alle anderen 
Felder automatisch aktualisiert.

4 Mit der Use Subframes-Option können Sie 
Material mit größerer Genauigkeit verschieben.

5 Klicken Sie auf OK. Das Material wird um den 
angegebenen Wert nach vorne oder hinten 
verschoben. 

Wenn nur ein Teil eines Clips selektiert wurde, 
werden aus der Selektion und aus dem Material 
rechts und links der Selektion neue Clips gebildet. 

Der Shift-Befehl hat immer die gleiche Wirkung, 
unabhängig vom Edit-Modus. Aneinander 
grenzende Clips werden beispielsweise im 
Shuffle-Modus überlappt, im Spot-Modus öffnet 
sich nicht das Spot-Dialogfeld und im Grid-Modus 
wird das Material beim Verschieben nicht am 
Raster ausgerichtet.

Sperren von Clips
In vielen Fällen möchten Sie vielleicht. Clips oder 
Clipgruppen an einer bestimmten Zeitposition 
„sperren“, damit sie nicht versehentlich 
verschoben oder anderweitig bearbeitet werden. 
Pro Tools bietet zwei verschiedene Befehle zum 
Sperren von Clips: „Edit Lock“ und „Time Lock“.

Edit Lock für Clips
Wenn Sie einen Clip oder eine Gruppe von Clips vor 
unbeabsichtigtem Editieren schützen möchten, 
können Sie dafür die Edit Lock-Funktion aktivieren. 
Clips mit aktiviertem Edit Lock können nicht editiert 
(etwa Ausschneiden, Löschen, Separieren, Trimmen 
oder Anpassen des Clip-Gain) oder an eine andere 
Zeitposition verschoben werden. Kopierte Clips mit 
aktiviertem „Edit Lock“ können in beliebige Spuren 
oder Zeitpositionen eingefügt werden, jedoch ist an 
der neuen Zeitposition ebenfalls die Edit Lock-
Funktion aktiviert.

So aktivieren (bzw. deaktivieren) Sie „Edit Lock“ 
für einen Clip:

1 Selektieren Sie mit dem Time Grabber die 
Clips, die Sie sperren (oder deren Sperrung Sie 
aufheben) möchten. Die Clips können sich 
dabei auch auf mehreren Spuren befinden.

2 Wählen Sie Clip > Edit Lock/Unlock.

Shift (Dialogfeld)
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Bei Aktivierung der Funktion wird im Clip ein kleines 
Edit Lock-Symbol angezeigt und der Clip kann nicht 
verschoben, gelöscht oder editiert werden. Wenn Sie 
versuchen, einen Editiervorgang durchzuführen, durch 
den der gesperrte Clip verschoben wird, gibt Pro Tools 
eine entsprechende Warnmeldung aus (siehe 
„Zulassen des Editierens von Clips mit aktiviertem 
„Edit Lock““ auf Seite 866).

Im Shuffle-Modus werden Clips mit aktiviertem 
„Edit Lock“ sowie alle darauf folgenden Clips 
nicht mitbewegt, wenn andere benachbarte Clips 
verschoben werden.

Auf tickbasierten Spuren mit aktiviertem Elastic 
Audio passen sich Clips mit aktiviertem „Edit Lock“ 
Tempowechseln an; es kann jedoch keine andere 
Elastic Audio-Verarbeitung (etwa Quantisieren oder 
manuelles Warping) angewendet werden.

Time Lock für Clips
Wenn Clips an einer bestimmten Stelle in einer 
Spur bleiben sollen (eine Takt-, SMPTE-Frame- 
oder Sample-Position), können Sie diese sperren, 
damit sie nicht versehentlich verschoben werden 
können. Clips mit aktiviertem „Time Lock“ können 
nicht verschoben werden. Sie können jedoch so 
editiert werden, dass der Clip nicht an eine andere 
Zeitposition verschoben wird (etwa durch 

Separieren, Trimmen, AudioSuite-Verarbeitung 
oder sogar Verschieben des Clips auf eine andere 
Spur). Clips mit aktiviertem „Time Lock“ können 
außerdem gelöscht werden. Wenn ein Clip mit 
„Time Lock“ separiert wird, werden neue Clips 
ebenfalls auf ihren Zeitpositionen gesperrt.

So aktivieren bzw. deaktivieren Sie „Time Lock“ 
für einen Clip:

1 Selektieren Sie mit dem Time Grabber die 
Clips, deren Zeitpositionen Sie sperren (oder 
entsperren) möchten. Die Clips können sich 
dabei auch auf mehreren Spuren befinden.

2 Wählen Sie Clip > Time Lock/Unlock.

Bei Aktivierung der Funktion wird im Clip 
ein kleines Time Lock-Symbol angezeigt und 
der Clip kann nicht verschoben, jedoch editiert 
oder sogar gelöscht werden.

Im Shuffle-Modus werden Clips mit aktiviertem 
„Time Lock“ sowie alle darauf folgenden Clips 
nicht mitbewegt, wenn andere benachbarte Clips 
verschoben werden.

Auf tickbasierten Spuren mit aktiviertem Elastic 
Audio passen sich Clips mit aktiviertem „Time 
Lock“ Tempowechseln an; es kann jedoch keine 
andere Elastic Audio-Verarbeitung (etwa 
Quantisieren oder manuelles Warping) angewendet 
werden.

Drücken Sie Strg + L (Windows) bzw. Befehl + 
L (Mac), um die Edit Lock-Funktion für 
den selektierten Clip zu aktivieren oder 
zu deaktivieren.

Edit Lock-Symbol

Drücken Sie Alt + Windows + L (Windows) 
bzw. Wahl + Befehl + L (Mac), um die Time 
Lock-Funktion für den selektierten Clip 
zu aktivieren oder zu deaktivieren.

Time Lock-Symbol
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Zulassen des Editierens von 
Clips mit aktiviertem „Edit Lock“
Wenn Sie versuchen, einen Clip mit aktiviertem 
„Edit Lock“ zu editieren, zeigt Pro Tools eine 
Warnung mit der Aufforderung an, den 
Editiervorgang durch Klicken auf Cancel oder Allow 
abzubrechen bzw. zuzulassen. Wenn Sie einen 
Editiervorgang zulassen, bei dem ein Teil des Clips 
nicht verändert wird, bleibt der Clip gesperrt.

Aktivieren und Deaktivieren 
der Stummschaltung von Clips
Durch den Mute/Unmute Clip-Befehl wird 
die Wiedergabe eines selektierten Clips 
stummgeschaltet (Mute). Wird der Befehl 
ein zweites Mal verwendet, wird der Clip wieder 
normal wiedergegeben. Damit ihr Status klar 
ersichtlich ist, werden stummgeschaltete Clips 
blasser angezeigt.

So aktivieren oder deaktivieren Sie die 
Stummschaltung eines oder mehrerer Clips:

1 Selektieren Sie mit dem Time Grabber die Clips, 
für die Sie die Stummschaltung aktivieren oder 
deaktivieren möchten. Die Clips können sich 
dabei auch auf mehreren Spuren befinden.

2 Wählen Sie Edit > Mute/Unmute. 
Stummgeschaltete Clips werden abgeblendet.

Entfernen von stillen 
Passagen aus Clips
Mit dem Strip Silence-Befehl können Sie 
Audioselektionen über mehrere Spuren hinweg 
analysieren und stille Passagen entfernen (oder 
extrahieren), indem Sie die Selektion in kleinere Clips 
unterteilen und die stillen Passagen entfernen.

Mithilfe von „Strip Silence“ können Sie stille 
Passagen aus einem Clip entfernen oder stattdessen 
das Audiomaterial extrahieren und die stillen Passagen 
beibehalten. Das Entfernen stiller Passagen ist 
nützlich, wenn Audiomaterial komprimiert werden 
soll (siehe „Komprimieren einer Audiodatei“ auf 
Seite 621). Mit dem Strip Silence-Befehl können Sie 
die Selektion automatisch in separate Clips unterteilen, 
um Audiomaterial auf Notenwerte zu quantisieren 
oder Soundeffekte auf bestimmte SMPTE-Positionen 
zu setzen.

Automatisches Benennen für 
„Strip Silence“
Über die Rename-Schaltfläche im Strip Silence-
Fenster wird das Rename Selected Clips-Dialogfeld 
aufgerufen, in dem bestimmt werden kann, wie Clips 
beim Entfernen der stillen Passagen benannt werden. 
Das Dialogfeld hat die vorherigen Einstellungen 
gespeichert, die Sie löschen können, indem Sie auf 
die Clear-Schaltfläche klicken.

Stummgeschalteter Audioclip (in der Mitte)

Rename Selected Clips-Dialogfeld
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Name. – legt die grundsätzliche Bezeichnung für 
Clips fest, die mit dem Strip Silence-Befehl 
erzeugt werden.

Number. – legt einen Zahlenwert fest, mit dem die 
automatische fortlaufende Nummerierung 
begonnen wird. 

Zeros. – legt die Anzahl der Nullen fest, die den 
automatisch bestimmten fortlaufenden Nummern 
vorangestellt werden.

Suffix. – legt einen Text fest, der an den Namen 
angehängt und nach der fortlaufenden 
automatischen Nummerierung dargestellt wird.

Sie können etwa die Bezeichnungsoptionen 
folgendermaßen einstellen:

• Name = SFX

• Auto Number Start = 23

• Leading Zeros = 1

• Suffix = .Reel1

In diesem Fall würden die mit dem Strip Silence-
Befehl erzeugten Clips folgende Namen erhalten:

• SFX023.Reel1

• SFX024.Reel1

• SFX025.Reel1

• SFX026.Reel1

Verwenden von „Strip Silence“

So entfernen Sie stille Passagen aus einer 
Audioselektion:

1 Selektieren Sie einen oder mehrer Audioclips. 

2 Wählen Sie Edit > Strip Silence.

3 Um ein Benennungsschema für mit dem Strip 
Silence-Befehl erstellte Clips einzustellen, 
öffnen Sie das Rename Selected Clips-
Dialogfeld durch Klicken auf Rename. Weitere 
Hinweise finden Sie unter „Automatisches 
Benennen für „Strip Silence““ auf Seite 866.

4 Passen Sie im Strip Silence-Fenster die 
Einstellungen für Strip Threshold und „Minimum 
Strip Duration“ (Min Strip) an, bis in der Selektion 
Strip Silence-Rechtecke erscheinen.

Um mit diesen Steuerelementen eine feinere 
Auflösung zu erreichen, halten Sie beim Anpassen 
die Strg-Taste (Windows) bzw. die Befehlstaste 
(Mac) gedrückt.

5 Wenn Sie das Material, das sich vor und nach den 
neuen Clips befindet, beibehalten möchten, 
passen Sie die Einstellungen für Clip Start Pad 
und Clip End Pad entsprechend an.

Drücken Sie Strg + U (Windows) bzw. Befehl + 
U (Mac), um das Strip Silence-Fenster 
zu öffnen.

Strip Silence-Rechtecke

Strip Silence-Befehl, Sicherheitsmaterial am Start- 
und Endpunkt des Clips

Attack-Phase, für die 
Sicherheitsmaterial 
angewendet werden soll

Decay-Phase, für die 
Sicherheitsmaterial 
angewendet werden soll
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6 Sobald die Strip Silence-Rechtecke die 
Audioabschnitte, die Sie erhalten möchten, 
umgeben, klicken Sie auf die Strip-Schaltfläche.

Das als Stille definierte Material wird aus der 
Selektion entfernt und es werden neue Clips 
erstellt, die ebenfalls in der Clipliste erscheinen.

Der Strip Silence-Befehl ist nicht destruktiv und 
entfernt keine Audiodaten aus übergeordneten 
Audiodateien. Neben dem Undo-Befehl können 
Sie auch den Heal Separation-Befehl zur 
Wiederherstellung von entferntem 
Material verwenden.

So extrahieren Sie mit „Strip Silence“ Audio 
aus einer Audioselektion:

1 Treffen Sie eine Edit-Selektion.

2 Wählen Sie Edit > Strip Silence.

3 Um ein Benennungsschema für mit dem Strip 
Silence-Befehl erstellte Clips einzustellen, öffnen 
Sie das Rename Selected Clips-Dialogfeld durch 
Klicken auf Rename (siehe „Automatisches 
Benennen für „Strip Silence““ auf Seite 866).

4 Passen Sie im Strip Silence-Fenster die 
Einstellungen für Strip Threshold und „Minimum 
Strip Duration“ (Min Strip) an, bis die Strip 
Silence-Rechtecke in der Selektion erscheinen.

5 Klicken Sie auf Extract.

Alles Audio über dem festgelegten Schwellenwert 
wird gelöscht und die „stillen“ Passagen der Spur 
bleiben zurück.

So separieren Sie Clips mit „Strip Silence“:

1 Nehmen Sie eine Edit- oder Timeline-Selektion 
vor.

2 Wählen Sie Edit > Strip Silence.

3 Um ein Benennungsschema für mit dem Strip 
Silence-Befehl erstellte Clips einzustellen, öffnen 
Sie das Rename Selected Clips-Dialogfeld durch 
Klicken auf Rename (siehe „Automatisches 
Benennen für „Strip Silence““ auf Seite 866).

4 Passen Sie im Strip Silence-Fenster die 
Einstellungen für Strip Threshold und „Minimum 
Strip Duration“ (Min Strip) an, bis die Strip 
Silence-Rechtecke in der Selektion erscheinen.

5 Klicken Sie auf Separate.

Neue Clips werden entsprechend den durch „Strip 
Silence“ erkannten Grenzen erstellt. 

Strip Silence-Fenster
Im Strip Silence-Fenster befinden sich die 
folgenden Steuerelemente, mit denen Sie die 
Parameter festlegen können, durch die stille 
Passagen bei der Verwendung des Strip Silence-
Befehls definiert werden.

Wenn Sie diese Steuerelemente verwenden, werden 
in der Selektion vorübergehend Rechtecke bei stillen 
Passagen angezeigt, auf die sich die Strip-, Extract- 
oder Separate-Befehle auswirken.

„Strip Silence“ ist auf Stereo- und 
Mehrkanalspuren anwendbar, wobei deren 
Audioclips phasenkohärent bleiben.

Strip Silence (Fenster)

Strip Silence-Rechtecke
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Strip Threshold. – stellt den Schwellenwert der 
Amplitude für „Strip Silence“ ein (von -96 dB bis 
0 dB). Audiosignale, die unter diesem Schwellenwert 
liegen, werden als Stille ausgelegt und entfernt. 
Audiosignale oberhalb des Schwellenwerts werden 
beibehalten und als neue Clips definiert.

Minimum Strip Duration. – stellt ein, wie lange das 
Signal unter dem Schwellenwert bleiben muss, 
um als Stille identifiziert zu werden (von 0 bis 
4.000 ms). Verwenden Sie dieses Steuerelement, um 
zu vermeiden, dass innerhalb einer Selektion zahllose 
kleine Clips erscheinen.

Clip Start Pad. – bestimmt einen Zeitwert, der dem 
Anfang jedes neuen mit „Strip Silence“ erstellten 
Clips hinzugefügt wird. Das ist nützlich für die 
Erhaltung von musikalischem Material, das unter den 
Schwellenwert fällt, wie etwa das Atemholen vor 
dem Einsatz der Stimme oder das Gleiten der Finger 
über Gitarrensaiten vor einem Akkord.

Clip End Pad. – bestimmt einen Zeitwert, der dem 
Ende jedes neuen mit „Strip Silence“ erstellten Clips 
hinzugefügt wird. Damit können die Nuancen im 
verklingenden Material erhalten werden.

Strip. – entfernt die erkannte stille Passage, belässt 
jedoch Clips mit Audiomaterial auf der Spur.

Extract. – entfernt das Audiomaterial und lässt die 
stillen Passagen der Spur aus (mit anderen Worten: 
eine „umgekehrte“ Strip Silence-Funktion, die ideal 
zum Erzeugen von Raumton oder Hall ist).

Rename. – öffnet das Rename Selected Clips-
Dialogfeld (siehe „Automatisches Benennen für 
„Strip Silence““ auf Seite 866).

Trennen. – unterteilt Clips entsprechend den durch 
„Strip Silence“ erkannten Grenzen. 

Einfügen von stillen Passagen
Der Insert Silence-Befehl stellt eine einfache und 
bequeme Möglichkeit dar, um stille Passagen 
in Audio-, MIDI- und Instrumentenspuren 
einzufügen. Mit diesem Befehl können Sie eine 
Selektion auf einer Spur (oder auf mehreren Spuren) 
vornehmen und eine stille Passage genau derselben 
Dauer an beliebiger Stelle einfügen. 

Wenn Sie sich im Shuffle-Modus befinden, werden 
sämtliche Daten auf der Spur entsprechend der 
Selektion nach hinten verschoben.

Im Grid-Modus funktioniert der Insert Silence-
Befehl genauso wie der Clear-Befehl.

Shuffle-Modus. – wenn Sie im Shuffle-Modus 
stille Passagen in mehrere Spuren einfügen, gelten 
folgende Bedingungen:

 Wenn das Darstellungsformat einer Spur auf 
Audio oder MIDI eingestellt ist, wird eine stille 
Passage der ausgewählten Dauer in die Audio- bzw. 
MIDI-Daten und in sämtlichen zugrunde liegenden 
Automationsdaten aller selektierten Spuren 
eingefügt. Alle nachfolgenden Clips werden um die 
Dauer der eingefügten stillen Passage verschoben. 
Bei MIDI-Spuren sind nur die Noten betroffen, 
die vollständig im selektierten Bereich liegen. Wenn 
Sie also das Ende einer Note selektiert haben und 
stille Passagen einfügen, bleibt die Note unverändert.

 Wenn das Darstellungsformat aller selektierten 
Spuren auf Automation eingestellt ist, werden nur 
Automationsdaten des dargestellten Typs aus dem 
selektierten Bereich entfernt. Clips werden nicht 
verschoben. Stattdessen erscheint eine Lücke, die der 
Länge der Selektion entspricht.

Der Insert Silence-Befehl wirkt sich auch auf 
Marker in allen ausgewählten Dirigentenleisten 
(wie die Tempo- oder Meter-Leisten) aus.
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 Wenn das Anzeigeformat aller selektierten Spuren 
auf Automation eingestellt ist, halten Sie beim 
Auswählen des Insert Silence-Befehls die Windows-
Taste (Windows) bzw. die ctrl-Taste (Mac) gedrückt, 
um auf sämtlichen Automations-Playlists für alle 
selektierten Spuren stille Passagen einzufügen. Clips 
werden nicht verschoben.

Slip-Modus. – wenn Sie im Slip-Modus stille 
Passagen in mehrere Spuren einfügen, gelten 
folgende Bedingungen:

 Wenn das Darstellungsformat einer Spur auf 
Audio oder MIDI eingestellt ist, werden die 
Audio- bzw. MIDI-Daten und sämtliche zugrunde 
liegenden Automationsdaten aller selektierten 
Spuren aus dem selektierten Bereich entfernt.

 Wenn das Darstellungsformat aller selektierten 
Spuren auf Automation eingestellt ist, wird nur in 
den Automationsdatentyp eine stille Passage 
eingefügt, der auf der jeweiligen Spur sichtbar ist.

 Wenn das Anzeigeformat aller selektierten Spuren 
auf Automation eingestellt ist, halten Sie beim 
Auswählen des Insert Silence-Befehls die Windows-
Taste (Windows) bzw. die ctrl-Taste (Mac) gedrückt, 
um auf sämtlichen Automations-Playlists für alle 
selektierten Spuren stille Passagen einzufügen.

So fügen Sie stille Passagen in eine Spur ein:

1 Nehmen Sie in einer Spur oder in Spuren eine 
Selektion vor. Die Länge dieser Selektion bestimmt 
die Länge der eingefügten leeren Passage.

2 Wählen Sie Edit > Insert Silence.

Im Shuffle-Modus fügt Pro Tools eine stille Passage 
mit der ausgewählten Länge ein. Im Verlauf dieses 
Vorgangs werden die Clips am Einfügepunkt geteilt 
und die neuen Clips um die Länge der Selektion auf 
der Spur nach hinten verschoben.

Duplizieren von Clips
Mit dem Duplicate-Befehl wird eine Selektion 
kopiert und direkt hinter ihrem Endpunkt 
wiederholt (dupliziert). Obwohl diese Funktion 
den Befehlen Copy und Paste sehr ähnlich ist, 
kann der Duplicate-Befehl in manchen Fällen 
praktischer und schneller sein, besonders wenn Sie 
mit Daten auf mehreren Spuren arbeiten. 

Um mehrere Kopien einer Selektion anzufertigen, 
verwenden Sie den Repeat-Befehl (siehe 
„Wiederholen von Clips“ auf Seite 871). Sie können 
Clips auch loopen (siehe „Clip-Loops“ auf Seite 873).

Wie bei den Befehlen Copy und Paste sind auch beim 
Duplizieren von Material auf mehreren Spuren 
bestimmte Regeln zu beachten (siehe „Editieren über 
mehrere Spuren hinweg“ auf Seite 542).

So duplizieren Sie eine Selektion oder einen Clip:

1 Wenn Sie mit Material arbeiten, das auf einem 
Taktraster basiert (etwa Loops), stellen Sie die 
Haupt-Zeitskala auf „Bars|Beats“ ein.

2 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

3 Treffen Sie eine Edit-Selektion.

4 Wählen Sie Edit > Duplicate. Das Material wird 
unmittelbar hinter dem Endpunkt der Selektion 
platziert.

Im Shuffle-Modus wird das duplizierte Material 
unmittelbar hinter dem Endpunkt der Selektion 
platziert. Clips, die auf den Endpunkt der Selektion 
folgen, werden verschoben, damit das duplizierte 
Material platziert werden kann. Im Slip-Modus 
überlappt das duplizierte Material die 
benachbarten Daten.

Drücken Sie Strg + D (Windows) bzw. Befehl + 
D (Mac), um selektierte Clips zu duplizieren.
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Bei Anwendung des Duplicate- oder Repeat-
Befehls auf mit dem Time Grabber-Tool 
selektierte MIDI-Noten wird das duplizierte 
Material immer erst einen Takt später eingefügt 
und mit bereits vorhandenem Spurmaterial 
zusammengeführt (anstatt es zu ersetzen).

Duplizieren von Audio unter 
Beibehaltung des Takts
Bei Anwendung des Duplicate- oder Repeat-Befehls 
auf Audiomaterial, das genau auf dem Schlag liegen 
soll (wie bei Rhythmus-Loops), ist es wichtig, das 
Audiomaterial entweder mit dem Selector-Tool oder 
durch Eingabe des Start- und Endpunktes im Event 
Edit-Bereich zu selektieren. Wenn Sie einen 
Audioclip hingegen mit dem Time Grabber-Tool 
selektieren (oder durch Doppelklicken mit dem 
Selector-Tool), könnte die neue Position wegen der 
Sample-Rundungen um einige Ticks von der 
gewünschten Position abweichen.

Um den Duplicate- oder Repeat-Befehl auf 
Audiomaterial anzuwenden, das nicht auf einem 
Taktraster basiert, können Sie die Zeitskala auf 
jedes Format außer „Bars|Beats“ einstellen. Damit 
wird sichergestellt, dass das duplizierte 
Audiomaterial die korrekte Anzahl Samples 
enthält und präzise platziert wird.

Wiederholen von Clips
Der Repeat-Befehl ähnelt dem Duplicate-Befehl. 
Es kann jedoch festgelegt werden, wie oft das 
selektierte Material vervielfältigt werden soll.

Wie bei den Befehlen Copy und Paste sind auch beim 
Wiederholen von Material auf mehreren Spuren 
bestimmte Regeln zu beachten (siehe „Editieren über 
mehrere Spuren hinweg“ auf Seite 542).

Sie können kopierte Daten wiederholt einfügen, bis 
eine Selektion vollständig ausgefüllt ist (siehe 
„Repeat To Fill Selection-Befehl“ auf Seite 541).

Sie können Clips auch loopen (siehe „Clip-Loops“ 
auf Seite 873).

So wiederholen Sie eine Selektion oder einen Clip:

1 Wenn Sie mit Material arbeiten, das auf einem 
Taktraster basiert (etwa Loops), stellen Sie die 
Haupt-Zeitskala auf „Bars|Beats“ ein.

2 Stellen Sie den Edit-Modus gegebenenfalls auf 
„Grid“ ein, um die Selektion durch das aktuell 
eingestellte Raster zu begrenzen. 

3 Treffen Sie eine Edit-Selektion.

4 Wählen Sie Edit > Repeat. Geben Sie im 
Repeat-Dialogfeld eine Zahl ein, mit der Sie 
bestimmen, wie oft das Material wiederholt 
werden soll, und klicken Sie dann auf OK.

Das Material wird unmittelbar nach dem Endpunkt 
der Selektion eingefügt und entsprechend der 
angegebenen Anzahl vervielfältigt.

Im Shuffle-Modus wird das wiederholte 
Material unmittelbar hinter dem Endpunkt der 
Selektion platziert. Clips, die auf den Endpunkt der 
Selektion folgen, werden verschoben, damit das 
wiederholte Material platziert werden kann. Im 
Slip-Modus überlappt das wiederholte Material 
nachfolgende Daten.

Repeat-Dialogfeld

Drücken Sie Alt + R (Windows) bzw. Wahl + 
R (Mac), um das Repeat-Dialogfeld für 
selektierte Clips zu öffnen.
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Kapitel 38: Clip-Loops und Clipgruppen

Pro Tools gibt Ihnen die Möglichkeit, Clips oder 
eine Gruppe von Clips (eine sogenannte 
Clipgruppe) zu loopen.

Clip-Loops
Mit Pro Tools können Sie Loops aus Audioclips, 
MIDI-Clips und Clipgruppen erstellen. Dies ist ein 
einfaches und effizientes Verfahren, mit dem ein 
einzelner Clip auf einer Spur oder mehrere Clips in 
mehreren Spuren mehrfach wiederholt werden 
können. Es bietet sich zum Komponieren und 
Arrangieren an. Das Erstellen von Loop-Clips 
bietet mehr Flexibilität als die Befehle Repeat 
und Duplicate.

Loop-Clips wiederholen den Quellclip so oft, wie 
im Clip Looping-Dialogfeld angegeben ist, oder so 
oft wie nötig, um die angegebene Loop-Länge zu 
füllen (beispielsweise 30 Sekunden oder bis zum 
nächsten Clip auf der Spur). Der Quellclip ist der 
ursprünglich zum Loopen selektierten Clip. Loop-
Iterationen sind alle Loop-Clips, die dem 
Quellclip folgen. Wenn keine Anzahl der 
Wiederholungen angegeben wurde, wird die letzte 
Loop-Iteration abgekürzt, damit das Ende der 
Selektion oder die angegebene Loop-Länge 
erreicht wird.

Ein Loop-Clip wird in ähnlicher Weise editiert wie 
Clipgruppen. Wenn Sie beispielsweise einen 
Loop-Clip selektieren und verschieben, werden 
sowohl der Quellclip als auch alle Loop-
Iterationen selektiert und verschoben.

Für Loop-Clips (alle Iterationen) wird ein Loop-
Symbol in der rechten unteren Ecke oder bei jeder 
Loop-Iteration angezeigt. 

Loop-Clip

Beim Loopen eines Clips werden die 
Automationsdaten des Quellclips nicht in den 
Loop aufgenommen. Um Automationsdaten der 
Quell-Region in die Loop-Iterationen 
zu kopieren, verwenden Sie die Befehle „Copy 
Special“ und „Paste Special Repeat To Fill 
Selection“ (siehe „Automation und Loop-
Clips“ auf Seite 876).

Loop-Clip

Quellclip Loop-Iterationen

Loop-Symbole
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Erstellen von Loop-Clips
Sie können Loop-Clips über den Loop-Befehl oder 
das Loop Trim-Tool erstellen. 

So erstellen Sie einen Loop-Clip:

1 Selektieren Sie einen Audio- oder MIDI-Clip 
oder eine Clipgruppe. 

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Loop. 

• Klicken Sie mit der rechten Maustaste auf 
den Clip, den Sie loopen möchten, und wählen 
Sie Loop.

3 Im Clip Looping-Dialogfeld haben Sie 
folgende Möglichkeiten:

• Wählen Sie die Number of Loops-Option 
und geben Sie an, wie oft der Clip wiederholt 
werden soll.

• Aktivieren Sie die Loop Length-Option und geben 
Sie die Dauer gemäß der Main-Zeitbasis ein. Ist die 
Gesamtdauer kein genaues Vielfaches der Dauer 
der Quell-Region, wird die letzte Loop-Iteration 
gekürzt.

• Aktivieren Sie die Option Loop Until End of 
Session or Next Clip. Der Clip wird in einem 
Loop bis zum Ende der Session oder bis zum 
nächsten Clip auf der Spur wiederholt. Die letzte 
Loop-Iteration wird gegebenenfalls gekürzt.

4 Um am Loop-Punkt einen Crossfade 
hinzuzufügen, aktivieren Sie die Enable 
Crossfade-Option. Gehen Sie zum Bearbeiten 
des Loop-Crossfades wie folgt vor:

• Klicken Sie auf Settings.

• Konfigurieren Sie die Loop-Crossfades.

• Klicken Sie auf OK.

5 Klicken Sie im Clip Looping-Dialogfeld auf OK.

Weitere Informationen zur Verwendung 
des Loop Trim-Tools finden Sie unter „Loop-
Trim-Tool“ auf Seite 563.

Sie können zum Loopen Clips über Spuren 
hinweg selektieren.

Clip Looping-Dialogfeld

Drücken Sie Strg + Alt + L (Windows) bzw. 
Befehl + Wahl + L (Mac), um das Clip 
Looping-Dialogfeld zu öffnen.

Loop Crossfade-Dialogfeld

Weitere Informationen zur Verwendung 
von Crossfades finden Sie unter Kapitel 28: 
„Fades und Crossfades“.
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Auflösen von Loop-Clips
So heben Sie einen Loop-Clip auf:

1 Selektieren Sie den Loop-Clip.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Unloop. 

• Klicken Sie mit der rechten Maustaste auf den 
Clip, dessen Loop Sie aufheben möchten, 
und wählen Sie Unloop.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie auf Remove, um den Loop 
aufzuheben und alle Loop-Iterationen mit 
Ausnahme der ersten vollständigen Loop-
Iteration (Quellclip) zu entfernen.

• Klicken Sie auf Flatten, um den Loop 
aufzuheben und die Loop-Iterationen in einzelne 
Clips umzuwandeln.

So heben Sie einen Loop auf und zerlegen die 
Selektion in ihre einzelnen Clips:

1 Selektieren Sie einen Loop-Clip, der 
mindestens eine Clipgruppe enthält.

2 Wählen Sie Clip > Ungroup All.

Loops aufheben und Loop-Clips 
zusammenfügen mit Separate Clips-
Menübefehlen

Die Separate Clips-Befehle (At Selection, On Grid 
und At Transients) heben vor dem Separieren 
automatisch die Loops für Loop-Clips auf und 
fügen sie zusammen.

Editieren von Loop-Clips
Loop-Clips können als Gruppe (alle Loop-
Iterationen zusammen) oder einzeln (jede Loop-
Iteration einzeln) editiert werden. Durch Selektieren 
eines Loop-Clips mit dem Grabber-Tool wird 
beispielsweise der gesamte Loop selektiert (der 
Quellclip und alle Loop-Iterationen). Durch das 
Klicken auf das Loop-Symbol einer Loop-Iteration 
wird dagegen nur diese eine Iteration selektiert.

Durch das Verschieben eines Loop-Clips werden 
der Quellclip und alle dazugehörigen Loop-
Iterationen als Gruppe verschoben. Loop-
Iterationen können nicht unabhängig von ihrem 
Quellclip verschoben werden. Wenn Sie einen 
weiteren, kürzeren Clip über seinen Loop-Clip 
verschieben oder einfügen, wird der Loop nach 
dem neuen Clip fortgesetzt. Die Teile eines 
separierten Loop-Clips können unabhängig 
voneinander angepasst werden. 

Um einen Loop-Clip als Gruppe (alle Loop-
Iterationen) zu selektieren, gehen Sie wie folgt vor:

 Klicken Sie mit dem Grabber- oder dem Smart-
Tool auf den Loop-Clip. 

 Doppelklicken Sie mit dem Selector-Tool auf 
den Loop-Clip.

Der Quellclip und alle Loop-Iterationen 
werden selektiert.

„Clip Ungroup“ hat bei Loops dieselbe 
Wirkung wie der Unloop-Befehl, wenn Sie 
anschließend „Flatten“ wählen.

Durch manuelles Warping eines Teils eines 
Loop-Clips in der Warp-Darstellung wird 
nur diese Iteration vom Loop-Clip getrennt.
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Um nur einen einzelnen Quellclip oder eine Loop-
Iteration zu selektieren, haben Sie folgende 
Möglichkeiten:

 Klicken Sie mit dem Grabber- oder dem Smart-
Tool auf das Loop-Symbol des Quellclips oder 
der Loop-Iteration.

 Klicken Sie mit dem Selector-Tool auf das 
Loop-Symbol und ziehen Sie es nach links, bis 
der Clip selektiert ist.

Springen zu Signalspitzen und Clipgrenzen

Wenn „Tab to Transients“ aktiviert ist, können Sie 
in einem Loop-Clip zu Signalspitzen und 
Clipgrenzen springen. Ist diese Option deaktiviert, 
können Sie mit der Tab-Taste nur zum Anfangs- 
und Endpunkt des gesamten Loop-Clips springen. 
Weitere Informationen finden Sie unter „Springen 
zu Signalspitzen“ auf Seite 587.

Trimmen von Loop-Clips
Loop-Clips können mit dem Trim-Tool, dem Loop 
Trim-Tool oder einem der Trim Clip-Befehle gekürzt 
werden. Mit dem Trim-Tool wird der gesamte Loop-
Clip getrimmt. Das Trim-Tool trimmt nur eine 
einzelne Loop-Iteration, wobei die Anzahl der Loop-
Iterationen reduziert oder erhöht wird, um die 
Gesamtdauer des Loop-Clips zu erreichen.

Wenn der Quellclip mit dem Trim-Tool nach links 
erweitert wird, um die Gesamtdauer des Loop-Clips 
zu ändern, wird der Quellclip in der Timeline nach 
vorne verschoben und Loop-Iterationen werden bis zu 
dem Punkt aufgefüllt, an dem die letzte ursprüngliche 
Loop-Iteration endet. Ist der nach links getrimmte 
Bereich ein Teil der Dauer des Quellclips, so wird 
dieser nicht verschoben. Stattdessen wird eine 
unvollständige Loop-Iteration links neben dem 
Quellclip eingefügt. Diese äußerst effiziente Funktion 
ermöglicht rasche Änderungen an Arrangements, 
wobei unvollständige Loops als „Auftakte“ 
verwendet oder Soundeffekte oder 
Umgebungsgeräusche im Soundtrack eines Films 
früher eingeführt werden können.

So trimmen Sie einen Loop-Clip auf die Selektion:

1 Verwenden Sie das Selector-Tool, um eine Edit-
Selektion einschließlich eines Teils oder des 
gesamten Loop-Clips vorzunehmen.

2 Wählen Sie Edit > Trim Clip und einen der Trim 

Clip-Befehle (To Selection, To Fill Selection, 
Start to Fill Selection oder End to Fill Selection).

Automation und Loop-Clips
Bei der Erstellung von Loops für einen Audioclip 
werden die Automationsdaten des Quellclips nicht in 
den Loop aufgenommen. Dadurch können Sie die 
Automation auf den gesamten Loop-Clip anwenden. 
So könnte sich beispielsweise ein langer Fade 
unabhängig von einer einzelnen Loop-Iteration ganz 
oder teilweise über einen Loop-Clip erstrecken. 

Sie können die Automation auch auf alle Loop-
Iterationen anwenden. Verwenden Sie für geloopte 
Audioclips die Befehle Copy Special und 
Paste Special-Repeat to Fill Selection, 
um Automationsdaten (teilweise oder vollständig) 
aus dem Quellclip zu kopieren und in allen oder 
einigen der Loop-Iterationen einzufügen. 

Loop-Symbol

Weitere Informationen zum Trimmen von Loop-
Clips mithilfe des Loop Trim-Tools finden 
Sie unter „Loop-Trim-Tool“ auf Seite 563.
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So kopieren Sie Automationsdaten in dem 
Quellclip und fügen sie in Loop-Iterationen ein:

1 Selektieren Sie den Quellclip.

2 Wählen Sie Edit > Copy Special und einen 
der Copy Special-Befehle (All Automation, 
Pan Automation oder Plug-In Automation), 
abhängig von den zu kopierenden 
Automationsdaten.

3 Selektieren Sie den gesamte Loop-Clip.

4 Wählen Sie Edit > Paste Special > Repeat to 

Fill Selection.

Clipgruppen
Eine Clipgruppe ist eine beliebige Kombination aus 
Audio- und MIDI-Clips, die so aussehen und sich so 
verhalten wie ein einzelner Clip. Clipgruppen sind im 
Wesentlichen Container, die mindestens einen Clip 
enthalten. Clipgruppen können auf einzelnen oder 
mehreren angrenzenden Audio-, MIDI- und 
Instrumentenspuren erstellt werden. Mithilfe von 
Clipgruppen können Sie mehrere Clips in „Makro“-
Clips für die Manipulation, das Editieren und 
Anordnen von Groove und Tempo „schachteln“. 

Clipgruppen können auf Spuren neben Standardclips 
platziert und mit vielen der Techniken editiert 
werden, die auch für normale Clips verwendet 
werden. Wenn bestimmte Befehle, etwa Cut oder 
Delete, auf eine Clipgruppe angewendet werden, 

wirken sie sich auf alle Clips in der Gruppe aus. 
Andere Editiervorgänge werden nur auf die Grenzen 
der Clipgruppe angewendet und wirken sich nicht auf 
die zugrunde liegenden Clips aus, beispielsweise 
Trim.

Jede Clipgruppe wird mit der Session als 
Clipgruppen-Datei (.cgrp) gespeichert. 
Clipgruppen-Dateien können aus verschiedenen 
Pro Tools-Sessions exportiert bzw. in solche 
importiert werden.

Clipgruppen sind besonders für folgende 
Vorgänge nützlich:

• Gruppieren tickbasierter Audioclips, die in viele 
kleinere Clips unterteilt wurden, etwa die 
einzelnen Schläge eines Schlagzeug-Pattern. 
Zahlreiche kleine Clips dieser Art können ohne 
Weiteres mit Beat Detective oder mithilfe 
des Befehls Separate Clip At Transients 
erstellt sowie als REX- oder ACID-Dateien 
importiert werden.

• Gruppieren von Teilen und Abschnitten Ihrer 
Session, um das Komponieren und Arrangieren 
zu erleichtern. So könnten Sie beispielsweise 
Blechbläser-Clips in einem Refrain gruppieren, 
um sie geschlossen in den nächsten Refrain 
zu kopieren.

„Pan Automation“ ausgewählt für „Copy Special“

„Pan Automation“, Option „Paste to Fill Selection“

Clipgruppen sind eigenständig und von Mix- 
und Edit-Gruppen völlig unabhängig.

Die Elastic Audio-Eigenschaften von 
Clipgruppen dürfen nicht bearbeitet werden.

Clipgruppen werden nicht auf Audiospuren 
unterstützt, für die die Playlists-Darstellung 
ausgewählt wurde. Wenn für eine Audiospur 
die Playlists-Darstellung ausgewählt wird, 
werden Clipgruppen auf der Spur 
automatisch aufgelöst. 
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Erstellen von Clipgruppen
So erstellen Sie eine Clipgruppe:

1 Selektieren Sie einen oder mehrere Clips in einer 
oder mehreren Spuren (weitere Informationen 
zu Multitrack-Clipgruppen finden Sie unter 
„Multitrack-Clipgruppen“ auf Seite 880).

Die Größe dieser Selektion bestimmt die Größe 
der Clipgruppe. Die Selektion kann an jeder 
beliebigen Clipgrenze, außerhalb der Clips oder 
mitten in einem Clip beginnen oder enden. Beginnt 
oder endet die Selektion innerhalb eines Clips, 
wird dieser bei Erstellen der Clipgruppe am 
Anfang bzw. Ende der Selektion separiert. 
Clipgruppen, die aus objektbasierten Selektionen 
erstellt wurden, enthalten alle selektierten und 
nicht selektierten Clips zwischen dem ersten und 
dem letzten selektierten Clip auf der Spur.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Group.

• Klicken Sie mit der rechten Maustaste auf die 
Edit-Selektion und wählen Sie Group.

Die Clipgruppe wird als ein Clip mit dem 
Clipgruppen-Symbol in der unteren linken Ecke 
angezeigt. Clipgruppen werden außerdem in der 
Clipliste angezeigt.

Zeitbasis-Format für Clipgruppen

Clipgruppen werden im gleichen Zeitbasis-Format 
(Samples oder Ticks) wie die Spuren erstellt, auf 
denen sie erzeugt wurden. Multitrack-Clipgruppen 
können sowohl sample- als auch tickbasierte 
Spuren enthalten.

Selektieren zu gruppierender Clips innerhalb 
einer Audiospur

Drücken Sie Strg + Alt + G (Windows) bzw. 
Befehl + Wahl + G (Mac), um selektierte 
Clips zu gruppieren.

Die Group und Ungroup Clip-Menübefehle 
werden unabhängig von der aktuellen 
Spurdarstellung auf jede Edit-Selektion 
angewendet.

Clipgruppen-Symbole auf einer Audiospur und in 
der Clipliste

Clipgruppen-Symbol auf einer Audiospur

MIDI-Clipgruppen-Symbol auf einer MIDI-Spur

Clipgruppen können auch aus leeren Selektionen 
erstellt werden. Dies ist besonders im Shuffle-
Modus nützlich, wenn Lücken zwischen den 
Clips erhalten bleiben sollen.
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Auflösen von Clipgruppen
So lösen Sie eine Clipgruppe auf:

1 Selektieren Sie eine Clipgruppe. 

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Ungroup.

• Klicken Sie mit der rechten Maustaste auf die 
Edit-Selektion und wählen Sie Ungroup.

Die Clipgruppe wird ausgeblendet und die darin 
enthaltenen Clips und eventuelle geschachtelte 
Clipgruppen werden angezeigt. Wenn mehrere 
geschachtelte Clipgruppen vorhanden sind, wird 
durch den Ungroup-Befehl nur die Gruppierung 
der vordersten Clipgruppe der obersten Schicht 
aufgehoben, sodass alle zugrunde liegenden 
Clipgruppen erhalten bleiben.

So heben Sie die Gruppierung einer 
Clipgruppe auf (einschließlich aller ihre 
geschachtelten Clipgruppen):

1 Selektieren Sie eine Clipgruppe.

2 Wählen Sie Clip > Ungroup All.

Wiederherstellen von 
Clipgruppen
Durch den Regroup-Menübefehl wird der letzte 
Ungroup-Befehl rückgängig gemacht und die 
einzelnen Clips werden wieder gemäß dem 
vorherigen Status der Clipgruppe gruppiert. 
Auf diese Weise können Sie Clipgruppen 
auflösen, die darin enthaltenen Clips editieren und 
anschließend die Clipgruppen für das 
Komponieren und Arrangieren auf höherer Ebene 
wiederherstellen.

So stellen Sie eine Clipgruppe wieder her:

1 Selektieren Sie einen Clip aus der 
aufgelösten Clipgruppe.

2 Wählen Sie Clip > Regroup.

Wenn Sie zuvor den Ungroup All-Befehl 
verwendet haben, werden mit Regroup auch alle 
verschachtelten Clipgruppen wiederhergestellt.

3 Wenn Sie eine aufgelöste Clipgruppe 
wiederhergestellt haben, die in der Session 
mehr als einmal verwendet wurde, führen Sie 
einen der folgenden Schritte aus, wenn das 
Change All-Dialogfeld geöffnet wird.

• Wählen Sie Modify, um die Änderungen auf 
sämtliche Instanzen der betreffenden 
Clipgruppe anzuwenden. 

• Wählen Sie Copy, um eine Kopie zu erstellen 
und Ihre Änderungen nur auf die kopierte 
Clipgruppe anzuwenden. 

Drücken Sie Strg + Alt + U (Windows) bzw. 
Befehl + Wahl + U (Mac), um selektierte 
Clipgruppen aufzulösen.

Drücken Sie Strg + Alt + R (Windows) bzw. 
Befehl + Wahl + R (Mac), um selektierte 
Clips, die Teil einer Clipgruppe waren, 
neu zu gruppieren.
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Multitrack-Clipgruppen
Multitrack-Clipgruppen (Clipgruppen, die sich 
über mehrere Spuren erstrecken) sind besonders 
zum Gruppieren mehrerer Stimmen wie etwa bei 
mit mehreren Mikrofonen aufgezeichneten 
Schlagzeug-Spuren sowie für Kompositions- und 
Arrangementaufgaben nützlich. Multitrack-
Clipgruppen können Audio-, MIDI- und 
Instrumentenspuren in beliebiger Kombination 
umfassen sowie tickbasierte oder samplebasierte 
Spuren oder beides enthalten.

Multitrack-Clipgruppen funktionieren weitgehend 
wie Clipgruppen innerhalb einer einzigen Spur. 
Sie werden in Form eines einzigen Objekts 
angezeigt, das sich über mehrere nebeneinander 
liegende Spuren erstreckt.

So erstellen Sie eine Multitrack-Clipgruppe:

1 Selektieren Sie mehrere Clips auf mehreren 
nebeneinander liegenden Spuren.

2 Wählen Sie Clip > Group.

Selektieren von Clips zum Gruppieren über mehrere 
Spuren hinweg

Clipgruppen-Symbol

Symbol für gemischte Clipgruppen (für eine 
Multitrack-Clipgruppe aus sample- und tickbasierten 
Audioclips sowie tickbasierten MIDI-Clips)

Bei der Erstellung von Multitrack-Clipgruppen 
werden zuerst Clipgruppen innerhalb der 
einzelnen Spuren erstellt und diese dann bei der 
Erstellung der übergeordneten Clipgruppe auf 
mehreren Spuren in dieser geschachtelt.

Der Regroup-Befehl steht für Multitrack-
Clipgruppen zur Verfügung.
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Separierte Multitrack-
Clipgruppen
Es ist möglich, Spuren in Multitrack-Clipgruppen 
einzufügen, zu verschieben, auszublenden oder zu 
löschen. Dabei wird die Clipgruppe jedoch 
möglicherweise unterteilt (separiert). Bei einer 
separierten Clipgruppe wird ein Bruch im 
Clipgruppen-Symbol angezeigt. Die separierten 
Clipgruppen können weiterhin wie eine einzige 
Clipgruppe behandelt werden. Das „zerbrochene“ 
Symbol weist jedoch darauf hin, dass die 
angezeigte Clipgruppe in irgendeiner Form 
unvollständig oder über nicht nebeneinander 
liegende Spuren verteilt ist.

Zur Separation von Clipgruppen kommt es bei den 
folgenden Vorgängen:

• Einfügen einer Spur innerhalb einer 
Multitrack-Clipgruppe

• Verschieben einer zu einer Multitrack-Clipgruppe 
gehörigen Spur, sodass sie nicht mehr neben den 
anderen Spuren der Clipgruppe liegt

• Ausblenden einer Spur, die zu einer Multitrack-
Clipgruppe gehört

• Löschen einer Spur, die zu einer 
Multitrack-Clipgruppe gehört

• Ändern des Tempos einer gemischten Clipgruppe 
mit sample- und tickbasiertem Material

• Aufnehmen in eine Clipgruppe

• Löschen von Playlists aus einer Spur, die zu 
einer Multitrack-Clipgruppe gehört

• Wechseln zur Playlists-Darstellung

• Anwenden von manuellem Warping in der 
Warp-Darstellung

In manchen Fällen werden separierte Clipgruppen 
benötigt. Wenn Sie beispielsweise dieselbe Begleitung 
für Strophe 1 und 2 eines Songs verwenden möchten, 
können Sie die entsprechenden Stimmen aus 
Strophe 1 gruppieren und als Clipgruppe in Strophe 2 
kopieren, wobei jedoch in der Mitte dieser 
Clipgruppen eine durchgehende Spur für den Gesang 
erhalten bleibt.

Symbol für separierte Clipgruppen

Wenn Sie eine Spur löschen möchten, 
die Clipgruppe jedoch intakt bleiben soll, 
lösen Sie zuerst die Clipgruppe auf, löschen 
Sie die Spur und stellen Sie die Clipgruppe 
dann wieder her. Die Clipgruppe wird 
vollständig wiederhergestellt, wobei nur 
die gelöschte Spur fehlt.
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Clipgruppen auf 
tickbasierten Spuren
Bei Änderungen des Tempos wird die Dauer von 
Clipgruppen auf tickbasierten Spuren durch 
Anpassen der Position aller darin enthaltenen 
Clips entsprechend angepasst. Dies ist beim 
Arrangieren von Rhythmusmaterial und bei der 
Wiedergabe von Clipgruppen nützlich, die aus 
REX- und ACID-Dateien importiert wurden. 

Ändern der Zeitbasis 
von Clipgruppen
Das Zeitbasis-Format einer Clipgruppe kann wie 
folgt geändert werden:

• Ändern der Zeitbasis der Spur

• Ziehen der Clipgruppe in eine Spur mit einer 
anderen Zeitbasis

Wenn Sie die Zeitbasis ändern, wird eine Kopie 
der betroffenen Clipgruppe erstellt. Beide 
Clipgruppen (das Original und die Kopie) werden 
in der Clipliste angezeigt, allerdings mit 
unterschiedlicher Zeitbasis.

Konvertieren von Samples in Ticks

Beim Ziehen einer Clipgruppe von einer 
samplebasierten Spur auf eine tickbasierte Spur 
ändert sich die Länge der Clipgruppe nicht. 
Der Grund dafür ist, dass Clipgruppen nach dem 
Verschieben in tickbasierte Spuren von Samples in 
Ticks konvertiert werden. Die Länge der Clipgruppe 
ändert sich nur, wenn anschließend das Tempo 
geändert wird. Ändern Sie gegebenenfalls das lokale 
Tempo auf der tickbasierten Spur, damit es mit dem 
Tempo der samplebasierten Clipgruppe 
übereinstimmt, bevor Sie eine samplebasierte 
Clipgruppe auf eine tickbasierte Spur verschieben.

Konvertieren von Ticks in Samples 

Beim Ziehen einer Clipgruppe von einer 
tickbasierten Spur auf eine samplebasierte Spur 
ändert sich die Länge der Clipgruppe nur, wenn sie 
auf eine andere zeitliche Position mit einem 
anderen Tempo verschoben wird. Der Grund dafür 
ist, dass Clipgruppen nach dem Verschieben in die 
samplebasierte Spur von Ticks in Samples 
konvertiert werden. 

Multitrack-Clipgruppen mit sample- und 
tickbasierten Spuren

Multitrack-Clipgruppen können sowohl sample- 
als auch tickbasierte Spuren enthalten. Durch das 
Ändern des Tempos wird jedoch die Clipgruppe 
zwischen samplebasierten und tickbasierten 
Spuren separiert.

Clipgruppe auf tickbasierter Audiospur bei 120 BPM 
und bei 160 BPM

Nach Tempoänderung in sample- und tickbasierte 
Spuren unterteilte Multitrack-Clipgruppe
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Editieren von Clipgruppen
Clipgruppen werden weitgehend auf dieselbe Art 
und Weise editiert wie normale Clips: Sie können 
benannt, verschoben, ausgeschnitten, kopiert, 
eingefügt, getrimmt, stummgeschaltet und 
gesperrt werden usw. Es gibt jedoch einige 
wichtige Unterschiede beim Editieren von 
normalen Clips und von Clipgruppen. 

Editieren von MIDI-Clipgruppen
Wird ein MIDI-Clip in einer Clipgruppe geändert, 
wird eine Kopie des Clips erstellt und über der 
Clipgruppe eingefügt. Wenn Sie beispielsweise 
aufnehmen, eine neue Note einzeichnen, MIDI-
Controller-Daten bearbeiten oder eine Timeline-
Selektion quantisieren, wird ein neuer Clip über 
der Clipgruppe erstellt.

Editieren von Audioclipgruppen
Bei manchen Befehlen zum Editieren von 
Audiomaterial werden neue Clips über der 
Clipgruppe erstellt. Wenn Sie diese Befehle 
verwenden, die Clipgruppe jedoch unverändert 
beibehalten möchten, lösen Sie diese auf, führen 
Sie die nötigen Schritte aus und stellen Sie 
anschließend die Clipgruppe wieder her.

Neue Clips über Clipgruppen werden bei den 
folgenden Editierbefehlen erstellt:

• Die AudioSuite-Verarbeitung von Clips, die in 
Clipgruppen enthalten sind, bewirkt die Erstellung 
eines neuen Clips über der Clipgruppe.

• Beim Konsolidieren der Selektion eines Clips, 
der in einer Clipgruppe enthalten ist, werden 
eine neue Audiodatei und ein neuer Clip über 
der Clipgruppe erstellt.

• Beim Aufnehmen in eine Clipgruppe werden 
eine neue Audiodatei und ein neuer Clip über 
der Clipgruppe erstellt.

• Beim Neuzeichnen von Wellenformen mit dem 
Pencil-Tool wird ein neuer Clip über der 
Clipgruppe erstellt.

Springen zu Signalspitzen 
und Clipgrenzen
Ist „Tab to Transients“ aktiviert, können Sie den 
Location-Cursor mithilfe der Tab-Taste zu 
Signalspitzen und Clipgrenzen innerhalb einer 
Clipgruppe springen lassen. 

Bei deaktivierter Tab to Transients-Option 
verschiebt die Tabulatortaste die Cursorposition 
nur an die Clipgruppen-Grenzen (und den Sync-
Punkt, falls vorhanden).

Trimmen von Clipgruppen

Das Trimmen von Clipgruppen mit dem Standard 
Trim-Tool funktioniert genau wie das Trimmen 
von normalen Clips, unabhängig davon, ob Sie 
eine Clipgruppe bestehend aus einer oder 
mehreren Spuren trimmen.

Beim Trimmen einer Clipgruppe werden nicht die 
zugrunde liegenden Clips, sondern die Clipgruppen-
Grenzen getrimmt. Die ursprüngliche Dauer und 
Position der zugrunde liegenden Clips bleibt 
unverändert. Dies gilt für alle in der Clipgruppe 
enthaltenen Audio- und MIDI-Clips sowie für darin 
geschachtelte Clipgruppen. Wenn Sie eine Clipgruppe 
beim Trimmen kürzen, können einige der zugrunde 
liegenden Clips außerhalb der Grenzen der 
getrimmten Clipgruppe liegen und sind dann bei der 
Wiedergabe nicht zu hören. 

Das Trimmen von Clipgruppen mit dem TC/E 
Trim-Tool wirkt sich je nachdem, welchen Cliptyp 
Sie in der Gruppe trimmen, nur auf Audio- oder 
MIDI-Clips aus und dabei wird ein neuer Clip über 
der Clipgruppe erstellt.

Wenn Sie die Gruppierung einer Clipgruppe nach 
dem Kürzen durch Trimmen auflösen, werden 
Audioclips, die sich außerhalb der Grenzen der 
aktuellen Clipgruppe befinden, entsprechend der 
Clipgruppen-Grenze getrimmt oder entfernt.

Weitere Informationen finden Sie unter 
„Springen zu Signalspitzen“ auf Seite 587.
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Aufnahme
Bei der Aufnahme von Audio oder MIDI werden 
neue Clips über (vor) den Clipgruppen erstellt, nicht 
in die Clipgruppe aufgenommen. Zur Aufnahme in 
eine Clipgruppe müssen Sie diese zuerst auflösen, 
dann die Aufnahme durchführen und schließlich die 
Clipgruppe wiederherstellen. Die Clipgruppe wird 
vollständig und einschließlich des aufgenommenen 
Materials wiederhergestellt.

Fades und Crossfades 
in Clipgruppen
Bei Clipgruppen können Fades und Crossfades 
genau wie bei normalen Clips verwendet werden. 
Fades sind nur bei Audioclips möglich. Crossfades 
sind sowohl zwischen Clipgruppen als auch 
zwischen Clipgruppen und normalen 
Audioclips möglich.

Zwei benachbarte Clipgruppen, bestehend aus 
mehreren Spuren mit Crossfades auf den Audio-, 
nicht jedoch auf den MIDI-Spuren

Beim Auflösen einer Clipgruppe werden 
alle Fades oder Crossfades auf der Ebene 
der Clipgruppe entfernt. Beim 
Wiederherstellen der Region-Gruppe mit 
dem Regroup-Befehl werden auch die 
Fades und Crossfades wiederhergestellt.

Clipgruppen, die Clips mit Fades enthalten, 
sind bei Elastic Audio-fähigen Spuren 
nicht zulässig.

Bei einem Tempowechsel für Clipgruppen auf 
tickbasierten Spuren müssen Sie 
möglicherweise die Gruppierung auflösen und 
wiederherstellen oder neue Fades erstellen und 
dann die Clips neu gruppieren, damit die Fades 
beibehalten werden.

Weitere Informationen zum Arbeiten mit 
Fades und Crossfades in Pro Tools finden Sie 
unter Kapitel 28: „Fades und Crossfades“.
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Clipgruppen und Clip-Gain
Clip-Gain-Einstellungen einzelner Clips werden in 
Clipgruppen beibehalten. Zusätzlich dazu können Sie 
die Clip-Gain-Einstellungen für die Clipgruppen 
einstellen. Clip-Gain-Editing bei Clipgruppen verhält 
sich genauso wie Clip-Gain-Editing bei einzelnen 
Clips (siehe „Clip-Gain“ auf Seite 611).

Um die Clip-Gain-Einstellungen einzelner Clips 
innerhalb einer Clipgruppe einzustellen, müssen 
Sie zuerst die Gruppierung aufheben, dann die 
Bearbeitung vornehmen und danach die 
Gruppe wiederherstellen. 

Clip-Gain-Einstellungen werden beibehalten, 
wenn Clipgruppen exportiert werden. Clipgruppen 
können später in andere Sessions mit denselben 
Clip-Gain-Einstellungen importiert werden.

Importieren und Exportieren 
von Clipgruppen-Dateien
Pro Tools kann Clipgruppen als Clipgruppen-
Dateien (.cgrp) importieren und exportieren, 
um folgende Vorgänge zu ermöglichen:

• Trennen (Separieren) von Clipgruppen-
Metadaten von Audio-Dateien, um überflüssige 
Dateikopiervorgänge beim Exportieren von 
Audioclip-Gruppen zu vermeiden, die aus 
mehreren Quelldateien zusammengesetzt sind

• Exportieren von MIDI-Daten als Teil 
einer Clipgruppe

• Erstellen mehrspuriger Loops

Clipgruppen-Dateien enthalten 
folgende Metadaten:

• Verweise auf alle Audiodateien in 
der Clipgruppe

• Namen und relative Position von Clips 
in Spuren

• Eingebettete Fades und Crossfades

• Clip-Gain-Einstellungen für die Clipgruppen 
sowie für einzelne Clips innerhalb der Gruppe

• Namen und Format von Clipgruppen (mit einer 
oder mehreren Spuren)

• Alle in der Clipgruppe vorhandenen MIDI-
Daten (Noten, Controller, Sysex usw.)

Clipgruppe mit angezeigten Clip-Gain-Einstellungen
Clipgruppen, die in Pro Tools 10 (.cgrp) 
erstellt werden, können nicht in niedrigere 
Pro Tools-Versionen importiert werden, 
aber Region-Gruppen (.rgp), die mit 
niedrigeren Pro Tools-Versionen erstellt 
wurden, können in Pro Tools 10 
importiert werden.
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• Spurnamen

• Elastic Audio Warp-Marker und TCE-Faktor

• Clip-Zeitbasis (Samples oder Ticks)

• Sync-Punkte

• Loops

• Tempo-Map

Folgende Metadaten sind nicht in Clipgruppen-
Dateien enthalten:

• Automation 

• Plug-Ins

• Spur-Routing

• Taktart-Map 

• Cliplisten-Informationen

Weitere Informationen finden Sie unter 
„Importieren und Exportieren von 
Clipgruppen-Dateien“ auf Seite 381.



Teil VIII: Automatisierte
Bearbeitung
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Kapitel 39: AudioSuite

AudioSuite-Plug-Ins werden zur gerenderten 
Bearbeitung und zur Änderung von Audiodateien 
auf Laufwerken verwendet. Bei der AudioSuite-
Bearbeitung wird eine gerenderte Audiobearbeitung 
(nicht in Echtzeit) auf ausgewählte Audioclips in 
Ihrer Pro Tools-Session angewendet. Je nachdem, 
wie Sie die AudioSuite-Plug-Ins konfigurieren, 
verändern Sie entweder die Originalaudiodatei oder 
erstellen eine neue Audiodatei. 

AudioSuite-Menü
Das AudioSuite-Menü bietet Zugriff auf die 
AudioSuite-Plug-Ins. Plug-Ins können im 
AudioSuite-Menü in Pro Tools als alphabetische 
Liste ohne Unterteilung (Flat List) oder nach 
Kategorie (Category), Hersteller (Manufacturer) 
oder Kategorie und Hersteller (Category and 
Manufacturer) sortiert werden. 

So rufen Sie das AudioSuite-Plug-In-Fenster auf:

1 Nehmen Sie eine Edit-Selektion vor, die den 
Audioclip bzw. die Clips umfasst, die Sie 
bearbeiten möchten.

2 Wählen Sie aus dem AudioSuite-Menü das 
gewünschte Plug-In aus.

AudioSuite-Fenster
Wenn Sie ein Plug-In aus dem AudioSuite-Menü 
auswählen, wird das AudioSuite-Fenster geöffnet. 
Über dieses Fenster können Sie auf die 
Steuerelemente der AudioSuite-Plug-Ins zugreifen 
und diese bearbeiten.

Weitere Informationen zu den einzelnen 
AudioSuite-Plug-Ins im Lieferumfang von 
Pro Tools finden Sie im Audio-Plug-Ins-
Handbuch.

Weitere Informationen finden Sie unter 
„Unterteilung des Plug-In-Menüs“ auf 
Seite 1043.

 AudioSuite-Fenster, in der Abbildung: EQ III 1-Band
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Kopfbereich des AudioSuite-
Fensters
Der Kopfbereich des AudioSuite-Fensters umfasst 
Steuerelemente zum Ändern von AudioSuite-
Plug-Ins, zum Festlegen von Voreinstellungen 
sowie zum Festlegen der Anwendung der 
AudioSuite-Bearbeitung.

AudioSuite-Plug-In-Selektor
Über dieses Menü können Sie alle im Plug-Ins-
Ordner installierten AudioSuite-Plug-Ins 
auswählen. Plug-Ins werden im Plug-In-Selektor 
entsprechend der Organize Plug-Ins Menu By-
Einstellung auf der Display Preferences-
Registerkarte aufgeführt.

Selection Reference
In diesem Menü können Sie auswählen, ob die 
Clips durch Selektion in einer Audiospur, einer 
Playlist oder der Clipliste zur Bearbeitung 
ausgewählt werden.

Wenn Sie einen Clip auf dem Bildschirm 
auswählen (entweder in einer Spur, Playlist oder 
der Clipliste), greift Pro Tools normalerweise auf 
beide Versionen dieses Clips zu. Da Sie 
möglicherweise nicht beide gleichzeitig bearbeiten 
möchten, können Sie mit diesem Menü die 
AudioSuite-Bearbeitung ganz einfach auf die 
jeweils ausgewählten Clips beschränken.

Playlist. – die AudioSuite-Bearbeitung wird auf 
Clips auf der Timeline (Playlists auf Audiospuren) 
angewendet. Bearbeitete Clips werden außerdem 
in der Clipliste angezeigt.

Clipliste. – die AudioSuite-Bearbeitung wird nur 
auf die in der Clipliste ausgewählten Clips 
angewendet. Die AudioSuite-Bearbeitung wird 
nicht auf Clips auf der Timeline (Playlists auf 
Audiospuren) angewendet.

 Kopfbereich des AudioSuite-Fensters

Plug-In-Menü („Flat List“ ohne Kategorien)

Use in Playlist (Schaltfläche)

Plug-In Settings-Menü

Ziel-Schaltfläche

Librarian-Menü

Selection Reference

Plug-In-Selektor

File Mode-Selektor
Process Mode-Selektor

Vergleich

Einstellungs-
auswahl

Nächste Einstellung

Vorherige Einstellung Selection Reference-Popup-Menü (hier: Invert-
Plug-In)

Wenn im Selection Reference-Popup-Menü 
der Befehl „Clip List“ ausgewählt wurde und 
Sie die Option „Use in Playlist“ aktivieren, 
wird die Bearbeitung sowohl in der Playlist 
als auch in der Clipliste auf den selektierten 
Clip angewendet.
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AudioSuite-Bearbeitung von Clipgruppen in 
der Clipliste

AudioSuite-Plug-Ins bearbeiten Clipgruppen in 
der Clipliste mit bestimmten Einschränkungen. 
Bei Audiodateien können AudioSuite-Prozesse 
auf alle Kopien einer eindeutigen Audiodatei in 
Ihrer Session angewendet werden, wenn die 
Clip List-Option und die Use Playlist-Option 
ausgewählt sind. Wenn jedoch eine Clipgruppe 
für die AudioSuite-Bearbeitung in der Clipliste 
ausgewählt ist, erkennt Pro Tools die Clipgruppe 
nicht als Audio. Dies liegt daran, dass eine 
Clipgruppe erst dann als Audiomaterial behandelt 
wird, wenn sie tatsächlich auf einer Spur 
verwendet wird. Um die AudioSuite-Bearbeitung 
auf eine Clipgruppe in der Clipliste anzuwenden, 
lösen Sie zunächst die Clipgruppe auf und 
gruppieren Sie sie nach der Bearbeitung neu.

So wenden Sie einen AudioSuite-Prozess 
gleichzeitig auf alle Kopien einer Clipgruppe 
in einer Session an:

1 Wählen Sie die zu bearbeitende Clipgruppe aus.

2 Wählen Sie im Cliplisten-Menü die Option 
Ungroup All. Alle Elemente der Gruppe 
bleiben ausgewählt.

3 Führen Sie die AudioSuite-Verarbeitung durch.

4 Wählen Sie im Cliplisten-Menü die 
Option Regroup.

Wählen Sie bei Aufforderung die Option Modify, 
um den AudioSuite-Vorgang auf alle Kopien der 
Clipgruppe in der Session anzuwenden, oder die 
Option Copy, um ihn nur auf die ausgewählte 
Clipgruppe anzuwenden.

Use In Playlist-Schaltfläche
Diese Schaltfläche bestimmt, ob die AudioSuite-
Bearbeitung die ausgewählten Clips an allen 
Stellen, an denen sie in der Session vorkommen, 
oder nur an denjenigen Stellen ersetzt, an denen 
die Clips derzeit vorkommen.

„Use in Playlist“ deaktiviert. – bei deaktivierter 
Use in Playlist-Funktion wird eine neue, 
bearbeitete Version des ausgewählten Clips in die 
Clipliste eingefügt. In der Session werden keine 
ursprünglichen Clips ersetzt oder überschrieben.

„Use in Playlist“ aktiviert, „Reference = Clip 
List“. – wenn Use in Playlist aktiviert ist und im 
Selection Reference-Popup-Menü der Eintrag 
„Clip List“ gewählt wurde, wird der ausgewählte 
Clip überall in der gesamten Session ersetzt.

„Use in Playlist“ aktiviert, „Reference = Playlist“. 
– wenn Use in Playlist aktiviert ist und im Selection 
Reference-Popup-Menü der Eintrag Playlist 
gewählt wurde, wird der Clip nur dort ersetzt, 
wo er in den Spuren im Edit-Fenster ausgewählt 
wurde. Wenn die Session andere Kopien des in 
anderen Playlists verwendeten Clips enthält, 
werden diese Kopien des ursprünglichen, 
unbearbeiteten Clips nicht ersetzt.

Wenn das Selection Reference-Popup-Menü 
auf „Clip List“ eingestellt ist, wird die „Use 
in Playlist“-Schaltfläche automatisch 
deaktiviert, um sicherzustellen, dass Sie nicht 
versehentlich alle Versionen des Clips in 
einer Session ersetzen.
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File Mode-Selektor
In diesem Menü können Sie bestimmen, 
ob das AudioSuite-Plug-In das ausgewählte 
Audiomaterial destruktiv oder nicht-destruktiv 
bearbeiten soll und wie die Originaldatei dabei 
verändert wird.

Es gibt drei File Mode-Optionen:

Overwrite Files. – die ausgewählten Clips werden 
destruktiv bearbeitet, wobei das ursprüngliche 
Audiomaterial überschrieben wird. Nicht alle 
AudioSuite-Plug-Ins können destruktiv 
genutzt werden. 

Create Individual Files. – die ausgewählten Clips 
werden nicht destruktiv bearbeitet, d. h., für jeden 
Clip wird eine neue Audiodatei erstellt. Die neuen 
Audiodateien werden der Session hinzugefügt und 
die ursprünglichen Quelldateien in der Clipliste 
bleiben unverändert. (Ob die bearbeitete 
Audiodatei zur aktuellen Playlist oder lediglich zur 
Clipliste hinzugefügt wird, hängt von der Selection 
Reference-Einstellung ab.)

Create Continuous File. – die ausgewählten Clips 
werden nicht destruktiv bearbeitet. Eine neue 
Audiodatei wird erstellt, in der alle ausgewählten 
Clips zu einem einheitlichen Clip zusammengefügt 
werden. Dieser Modus ist besonders dann zu 
empfehlen, wenn Sie verschiedene Takes in einer 
Spur zusammenfassen möchten. Er steht nicht zur 
Verfügung, wenn im Selection Reference-Popup-
Menü der Eintrag Clip List gewählt wurde.

Process Mode-Selektor
Wenn Sie mehrere Clips ausgewählt haben, 
können Sie in diesem Popup-Menü festlegen, 
ob die AudioSuite-Bearbeitung Clip für Clip oder 
als gesamte Auswahl ausgeführt werden soll.

Clip by Clip. – analysiert jeden Clip in einer 
Auswahl einzeln. Die Clips werden separat 
bearbeitet. 

Entire Selection. – analysiert die gesamte 
Auswahl. Alle Clips werden im Verhältnis zur 
gesamten Auswahl analysiert und bearbeitet.

Voreingestellte Steuerelemente 
des AudioSuite-Plug-Ins
Bei den meisten AudioSuite-Plug-Ins können 
Voreinstellungen (Plug-In-Einstellungsdateien) 
geladen und gespeichert werden. Manche 
AudioSuite-Plug-Ins, etwa DC Offset Removal 
oder Duplicate, verfügen jedoch nicht über 
Voreinstellungen, da sie keine Parameter-
Steuerelemente aufweisen.

File Mode-Popup-Menü (hier: Invert-Plug-In)

Die Create Continuous File-Option steht bei 
einigen zeitbezogenen Plug-Ins nicht zur 
Verfügung. Um ein ähnliches Ergebnis zu 
erzielen, verwenden Sie das Duplicate-
Plugin, um mit diesen Plug-Ins bearbeitete 
Clips zusammenzufassen.

Process Mode-Selektor (hier: Invert-Plug-In)

 Voreingestellte AudioSuite-Steuerelemente

Weitere Informationen zu den Plug-In-
Voreinstellungen finden Sie unter „Plug-In-
Voreinstellungen“ auf Seite 1053.

Plug-In Settings-Menü

Librarian-Menü

Vergleich

Einstellungsauswahl

Nächste Einstellung
Vorherige Einstellung



Kapitel 39: AudioSuite 893

Plug-In-Selektor. – hier können Sie ein beliebiges 
auf dem System installiertes AudioSuite-Plug-In 
auswählen.

Plug-In Settings-Menü. – ermöglicht das 
Kopieren, Einfügen, Speichern und Importieren 
von Plug-In-Einstellungen.

Plug-In Librarian-Menü. – ruft die 
Einstellungsdateien (Voreinstellungen) wieder 
auf, die im Settings-Ordner im Verzeichnis des 
Plug-Ins oder der aktuellen Session gespeichert 
wurden.

Schaltflächen für die nächste (+) und vorherige 
(–) Einstellung. – ermöglichen die Auswahl der 
nächsten bzw. vorherigen Einstellung im 
Librarian-Menü des Plug-Ins.

Einstellungsauswahl-Schaltfläche. – ruft das 
Plug-In Settings-Dialogfeld auf, in dem die 
Voreinstellungen für das aktuelle Plug-In 
aufgeführt sind. Aus dieser Liste können Sie eine 
neue Voreinstellung auswählen oder eine Reihe 
von Voreinstellungen abhören.

Vergleich. – diese Schaltfläche schaltet 
zwischen der gespeicherten ursprünglichen 
Plug-In-Voreinstellung und den von Ihnen 
vorgenommenen Änderungen um, um einen 
Vergleich zu ermöglichen.

Target-Schaltfläche
In Pro Tools können Sie mehrere AudioSuite-
Plug-In-Fenster gleichzeitig geöffnet haben. 
Im AudioSuite-Plug-In-Fenster gibt es eine 
Target-Schaltfläche. Nicht als Ziel aktivierte Plug-
In-Fenster bleiben geöffnet, während bei als Ziel 
aktivierten zwischen verschiedenen AudioSuite-
Plug-Ins gewechselt werden kann und sie durch 
Tastatureingabe angesprochen werden können.

So aktivieren Sie AudioSuite-Plug-In-Fenster 
als Ziel oder heben die Aktivierung auf:

 Klicken Sie auf die Ziel-Schaltfläche für 
das AudioSuite-Plug-In-Fenster, sodass es 
hervorgehoben (als Ziel ausgewählt) bzw. 
nicht hervorgehoben (die Auswahl als Ziel 
aufgehoben) wird.

Weitere AudioSuite-
Steuerelemente
Zusätzlich zu den üblichen AudioSuite-
Steuerelementen, die alle AudioSuite-Plug-Ins 
aufweisen, bieten bestimmte Plug-Ins eine Reihe 
besonderer Steuerfunktionen:

Key Input-Selektor

Wählen Sie eine Spur oder einen Bus, die bzw. 
der als Steuersignal für die Bearbeitung dient. 
Die Signalquelle des Key Input muss parallel zu dem 
zur Bearbeitung bestimmten Audiosignal abgespielt 
werden. Sidechain-Eingänge sind monophon. Siehe 
„Sidechain-Eingang“ auf Seite 1052.

Wenn Sie die aktuellen Plug-In-
Einstellungen vor Verwenden der 
Schaltflächen für die nächste und vorherige 
Einstellung nicht speichern, gehen sie 
verloren. Speichern Sie Ihre Plug-In-
Einstellungen mithilfe des Plug-In Settings-
Menüs daher immer als Voreinstellungen.

Sidechain-Eingänge für Plug-Ins haben 
keine Auswirkungen auf AudioSuite-
Prozesse, wenn „Selection Reference“ auf 
„Clip List“ eingestellt wurde.
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Channel Mode-Schaltfläche

Mit der Channel Mode-Schaltfläche können Sie 
nebeneinander liegende Kanäle innerhalb eines 
ausgewählten Clips so bearbeiten, als wären sie 
Mono- oder Stereospuren (und in manchen Fällen 
Mehrkanalspuren). Dies ist unabhängig von der 
Art der von ihnen belegten Spuren möglich.

Mono Mode. – bearbeitet jeden Kanal einer Reihe 
nebeneinander liegender Kanäle innerhalb eines 
ausgewählten Clips als separate Monospur. 
In diesem Modus wird beispielsweise ein aus 
sechs Monospuren bestehender Clip als sechs 
Monospuren bearbeitet.

Stereo-Modus. – bearbeitet jedes nebeneinander 
liegende Kanalpaar innerhalb eines ausgewählten 
Clips als eine Stereospur. Jedoch wird bei einer 
ungeraden Spurenanzahl die letzte Spur, der keine 
andere Spur zugeordnet werden konnte, in Mono 
und mit den Einstellungen des linken Kanals des 
Stereo-Plug-Ins bearbeitet. Wenn Sie auch diese 
Spur in Stereo bearbeiten möchten, wählen Sie 
eine zusätzliche (notfalls auch eine leere) Spur aus.

Ein Clip, der beispielsweise aus zwei Monospuren 
besteht, wird in diesem Modus als eine Stereospur 
bearbeitet, wobei die erste Monospur als linker 
Kanal und die zweite als rechter Kanal 
bearbeitet wird.

Multi-Modus. – bearbeitet einen Satz von drei oder 
mehr nebeneinander liegenden Kanälen innerhalb 
eines ausgewählten Clips als Mehrkanalspur, 
wobei die Anzahl der ausgewählten Kanäle die 
Spurart bestimmt. Beispielsweise werden fünf 
nebeneinander liegende ausgewählte Kanäle als 
eine 5.0-Spur und sieben nebeneinander liegende 
ausgewählte Kanäle als eine 7.1-Spur bearbeitet.

Unterer Bereich des 
AudioSuite-Fensters
Der untere Bereich des AudioSuite-Fensters 
umfasst Steuerelemente für eine Audiovorschau 
sowie zum Anwenden von AudioSuite-
Bearbeitungen.

Preview-Schaltfläche
Mit der Preview-Schaltfläche im AudioSuite-
Fenster starten Sie die Preview-Funktion 
(Audiovorschau), d. h., Sie können sich einen 
Effekt anhören, bevor Sie das Audiomaterial mit 
einem Plug-In bearbeiten. Während Sie mit 
„Preview“ Effekte abhören, können Sie 
Einstellungen der Plug-In-Steuerung vornehmen 
und so den Effekt feinabstimmen. Nicht alle 
AudioSuite-Plug-Ins unterstützen die 
Vorschaufunktion. 

Die Preview-Funktion routet Audiomaterial auf 
die Ausgänge, die für die Audition Path-
Einstellung der Outputs-Seite des I/O Setup-
Dialogfelds ausgewählt wurden. Vergewissern 
Sie sich, dass diese Option für das System richtig 
konfiguriert wurde, da andernfalls die 
Audiovorschau möglicherweise nicht hörbar ist. 

Der Multi-Modus steht nur für bestimmte 
Plug-Ins, wie etwa das Dynamics III-Plug-
In, zur Verfügung.

 Unterer Bereich des AudioSuite-Fensters

Weitere Informationen zur Verwendung des 
I/O Setup-Dialogfelds zur Konfiguration der 
Audio-Ausgänge Ihres Systems finden Sie 
unter „Abhörpfade“ auf Seite 78.

Vorhören-
Schaltfläche

Preview-Lautstärke

Preview-Pegelanzeigen Render-
Schaltfläche

Bypass-Schaltfläche Whole-File-Schaltfläche
Handle Length
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Vor dem Einsatz der Preview-Funktion für die 
AudioSuite-Bearbeitung sollten Sie Folgendes 
berücksichtigen: 

 Die Leistung der Preview-Funktion hängt von 
der Prozessorgeschwindigkeit ab. Die AudioSuite-
Effekte lassen sich mit schnellen Computern 
besser abhören als mit langsamen Modellen.

 Mit der Preview-Funktion wird nur die erste 
Stereospur bzw. das erste ausgewählte Paar 
Monospuren abgehört, unabhängig davon, 
wie viele Spuren und Clips ausgewählt wurden.

 Im Mono-Modus wird nur für den ersten Kanal 
eines ausgewählten Mehrkanal-Clips eine 
Vorschau angezeigt.

 Wenn die Bearbeitung im Clip für Clip-Modus 
erfolgt, wird in der Vorschau nur der erste Clip der 
Auswahl angezeigt. Aktivieren Sie vorübergehend 
Create Continuous File im File Mode-Menü, um 
alle ausgewählten Clips abhören zu können.

Preview-Lautstärke
Mit dem Preview Volume-Steuerelement im 
AudioSuite-Fenster können Sie die Lautstärke für 
die Vorschau der AudioSuite-Bearbeitung anpassen.

So passen Sie die Lautstärke für die Vorschau der 
AudioSuite-Bearbeitung an:

1 Klicken Sie auf das Steuerelement „Preview 
Volume“.

2 Ziehen Sie in dem daraufhin angezeigten 
Popup-Fader nach oben, um die 
Vorschaulautstärke zu erhöhen, oder nach 
unten, um sie zu verringern.

Preview Volume Level-Anzeigen

Die Lautstärkepegelanzeigen für die Vorschau 
zeigen die Pegel der AudioSuite-Bearbeitung in 
der Vorschau an. Auf diese Weise können Sie 
Übersteuerungen des bearbeiteten Signals 
erkennen.

Bypass-Schaltfläche
Wenn Bypass im AudioSuite-Fenster aktiviert ist, 
wird das ausgewählte Audiomaterial durch die 
Preview-Funktion ohne die AudioSuite-
Bearbeitung abgespielt. Die Bypass-Schaltfläche 
bezieht sich nur auf die Preview-Funktion. Sie hat 
keine direkten Auswirkungen auf die Bearbeitung 
mit AudioSuite-Plug-Ins. 

Umkehren-Schaltfläche
Pro Tools hat unten im AudioSuite-Plug-In-
Fenster eine Umkehren-Schaltfläche für Reverb- 
und Delay-Plug-Ins. Damit können Sie rasch mit 
einem Mausklick Reverse-Delay und Reverse-
Reverb-Effekte rendern. Das Klicken auf die 
Umkehren-Schaltfläche löst einen 
Dreifachprozess aus: 

• Erstens wird die Edit-Selektion umgekehrt.

• Zweitens wird die umgekehrte Edit-Selektion 
mit den aktuellen Plug-In-Einstellungen 
bearbeitet.

• Und drittens wird die bearbeitete Edit-Selektion 
umgekehrt. 

Whole-File-Schaltfläche
Wenn die Whole File-Schaltfläche im AudioSuite-
Fenster aktiviert ist, wird die ausgewählte 
Audiospur als neuer Clip gerendert, dessen Dauer 
genauso lang ist wie die Selektion. Der Clip kann 
jedoch auf die ganze Datei erweitert werden. Im 
Create Continuous File-Modus oder beim Rendern 
im Entire Selection-Modus in Verbindung mit dem 
Create Individual Files-Modus steht diese Option 
nicht zur Verfügung.Anpassen der Preview-Lautstärke
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Handle Length
Im Handle Length-Feld können Sie die Handle-
Länge (0,00 bis 60,00 Sekunden) für das Rendern 
eingeben. Das bedeutet, dass Sie Clips nach der 
AudioSuite-Bearbeitung bis zur festgelegten 
Handle-Länge über die gerenderte Selektion 
hinaus trimmen können. Weitere Informationen 
finden Sie unter „AudioSuite-Handles“ auf 
Seite 898.

Render-Schaltfläche
Durch Klicken auf die Render-Schaltfläche im 
AudioSuite-Fenster wird die AudioSuite-
Bearbeitung der Selektion gestartet. Die 
Bearbeitung kann auch während der Wiedergabe 
erfolgen (obwohl der Vorgang in diesem Fall 
eventuell mehr Zeit in Anspruch nimmt). 
Bearbeitete Dateien werden automatisch mit dem 
Namen der Clip- oder Audiodatei benannt und 
beinhalten ein Akronym für den ausgewählten 
AudioSuite-Prozess. 

Die neuen Dateien werden auf die Festplatte 
geschrieben, die für die Spur im Disk Allocation-
Dialogfeld als Zielverzeichnis angegeben wurde. 
Wenn sich der Clip derzeit nicht auf einer Spur 
befindet, wird die Datei auf derselben Festplatte 
gespeichert, auf der sich auch die Originaldatei 
befindet. Siehe „Automatische Benennung von 
mit AudioSuite bearbeiteten Audiodateien“ auf 
Seite 896.

Mehrkanalbearbeitung

Die meisten AudioSuite-Plug-Ins können bis zu 
48 Audiokanäle gleichzeitig bearbeiten.

Rückgängigmachen von AudioSuite-
Bearbeitungen

Wenn Sie eine Audioauswahl nichtdestruktiv 
bearbeitet haben, können Sie die AudioSuite-
Bearbeitungsschritte mit dem Undo- und dem 
Redo-Befehl wieder rückgängig machen bzw. 
wiederholen. Die Undo- und Redo-Funktionen 
stehen auch während der Audiowiedergabe zur 
Verfügung. 

Automatische Benennung von mit AudioSuite 
bearbeiteten Audiodateien

Pro Tools benennt automatisch alle bei der 
Bearbeitung mit AudioSuite erstellten Dateien 
nach dem verwendeten Plug-In-Typ. Der Name 
des Clips bestimmt das Präfix, während der Typ 
des AudioSuite-Plug-Ins das Suffix bestimmt.

Für die automatische Benennung gelten 
folgende Regeln:

 Neue Clips werden beginnend mit dem 
Clipnamen benannt, gefolgt von einer Abkürzung 
des aktuellen AudioSuite-Prozesses und der 
standardmäßigen Datei- und Clipnummerierung 
von Pro Tools.

 Wenn der „File Mode“ eines Plug-Ins auf 
Overwrite Files festgelegt ist, wird der ursprüngliche 
Name des Clips nicht geändert. 

 Wenn der „File Mode“ eines Plug-Ins auf 
Create Individual Files festgelegt ist, werden den 
Namen der neuen Clips Abkürzungen des Plug-In-
Namens nachgestellt.

Beim Bearbeiten mehrerer Clips mit 
unterschiedlichen Formaten (etwa Mono- 
und Mehrkanal-Surround) werden alle 
Kanäle gemäß dem Format des AudioSuite-
Plug-Ins bearbeitet. Sie können also 
Stereoclips mit Mono-AudioSuite-Plug-Ins 
bearbeiten und Monoclips mit Stereo-
AudioSuite-Plug-Ins.

Der Undo-Befehl steht bei der destruktiven 
Bearbeitung nicht zur Verfügung, da die 
Originaldatei dabei sofort überschrieben wird.
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Verwenden von AudioSuite-
Plug-Ins
AudioSuite-Plug-Ins können auf ganze Clips, 
Teile von Clips oder auf Selektionen angewendet 
werden, die aus ganzen Clips und Teilen von Clips 
bestehen und sich über eine oder mehrere Spuren 
erstrecken.

Wenn das im Edit-Fenster ausgewählte 
Audiomaterial Teile von Clips enthält, werden 
die Clips bei der Bearbeitung automatisch in zwei 
oder mehrere Clips geteilt. Es werden nur die 
ausgewählten Clips bearbeitet, andere Clips 
bleiben unverändert.

Audiodateien können nur dann mit AudioSuite-
Plug-Ins bearbeitet werden, wenn sie sich auf 
lokalen Laufwerken befinden. Es ist nicht 
möglich, Audiodateien über ein Netzwerk zu 
bearbeiten (es sei denn, es handelt sich um ein 
Avid Unity-Netzwerk). 

So bearbeiten Sie Audiomaterial mit einem 
AudioSuite-Plug-In: 

1 Sie haben folgende Möglichkeiten:

• Nehmen Sie eine Edit-Selektion des zu 
bearbeitenden Audiomaterials vor.

• Wählen Sie in der Clipliste die Audioclips aus, 
die Sie bearbeiten möchten.

2 Wählen Sie das gewünschte AudioSuite-Plug-
In im AudioSuite-Menü aus. 

3 Passen Sie die Steuerelemente des Plug-Ins an, 
um den gewünschten Effekt zu erreichen. Diese 
Einstellungen bestimmen, wie die Datei 
bearbeitet wird und welche Auswirkungen die 
Bearbeitung auf die ursprünglichen Clips hat. 

• Wenn Sie den ausgewählten Clip nur auf der 
zugehörigen Spur bearbeiten möchten, wählen 
Sie im Selection Reference-Menü den Eintrag 
Playlist. Alternativ können Sie, wenn Sie den 
ausgewählten Clip nur in der Clipliste bearbeiten 
möchten, den Eintrag Clip List wählen.

• Wenn Sie den ausgewählten Clip an sämtlichen 
Stellen, an denen er in der gesamten Session 
vorkommt, bearbeiten und aktualisieren möchten, 
aktivieren Sie die Use in Playlist-Schaltfläche 
(und wählen im Selection Reference-Menü den 
Eintrag Clip List). Wenn Sie nicht alle Instanzen 
des Clips aktualisieren möchten, deaktivieren Sie 
die Use in Playlist-Schaltfläche.

• Wählen Sie im „File Mode“ den Eintrag Overwrite 
Files, wenn das Plug-In destruktiv arbeiten soll. 
Dadurch werden die ursprünglichen Audiodateien 
überschrieben und nachhaltig verändert. 

• Wenn das Plug-In dagegen nicht destruktiv 
arbeiten soll, wählen Sie im „File Mode“ den 
Eintrag Create Individual Files. Für jeden 
Bearbeitungsvorgang mit den AudioSuite-Plug-
In-Einstellungen werden dann neue 
Audiodateien angelegt, die ursprünglichen 
Audiodateien bleiben unverändert.

• Wenn Sie mehrere Clips zur Bearbeitung 
ausgewählt haben und diese in einer einzigen, 
zusammenhängenden Datei zusammenfassen 
möchten, wählen Sie im „File Mode“ den 
Eintrag Create Continuous File.

4 Klicken Sie auf die Preview-Schaltfläche, 
um die AudioSuite-Bearbeitung des 
ausgewählten Materials abzuhören. 

5 Nehmen Sie bei Bedarf weitere Anpassungen 
an den Plug-In-Steuerelementen vor.

6 Wenn Sie mit dem Ergebnis zufrieden sind, 
klicken Sie auf die Render-Schaltfläche. 

Das ausgewählte Audiomaterial wird dann gemäß 
den gewählten Einstellungen bearbeitet. Pro Tools 
fügt dem Clipnamen Text hinzu, der den 
angewendeten AudioSuite-Vorgang angibt. Alle 
neuen Audiodateien werden in der Clipliste 
angezeigt.

Bei der Bearbeitung eines gesperrten Clips 
wird die Sperre aufgehoben, und bei der 
Bearbeitung eines stummgeschalteten Clips 
wird die Stummschaltung aufgehoben.
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Selektieren von Spuren für die 
AudioSuite-Bearbeitung
Da AudioSuite-Prozesse auf die von Ihnen 
ausgewählten Clips angewendet werden, sollten 
Sie nur diejenigen Clips oder Teile von Clips 
auswählen, die Sie wirklich bearbeiten möchten. 

Selektieren von Spuren für 
Delay- oder Reverb-Bearbeitung
Einige AudioSuite-Effekte wie Delay und Reverb 
fügen zusätzliches Material am Ende einer 
Selektion hinzu. Deshalb sollten Sie darauf 
achten, dass die Selektion länger als das 
Ausgangsmaterial ist, damit das Plug-In den Effekt 
in der Audiodatei einfügen kann. Wenn Sie nur das 
Quellmaterial selektieren und nicht genügend 
Platz am Ende lassen, werden alle Reverb- oder 
Delay-Effekte am Ende des Clips abgeschnitten.

Um die Effekte ohne Probleme unterbringen zu 
können, sollten Sie den Clip auf einer Spur 
platzieren und die Selektion über das Ende des 
Clips hinaus um den Wert verlängern, den Sie für 
Delay oder Reverb eingegeben haben. Der 
endgültige Effekt kann dann problemlos in die 
Selektion geschrieben werden. Wenn Sie mehr 
Zeit als erforderlich auswählen, können Sie diese 
nach dem Anwenden der AudioSuite-Bearbeitung 
trimmen.

AudioSuite-Handles
Pro Tools ermöglicht das Rendern von Clips mit 
AudioSuite-Plug-Ins und eingefügten „Handles“ 
(zusätzliches Sicherheitsmaterial), die über die 
aktuelle Edit-Selektion um 0 bis 60 Sekunden 
hinausragen. Der Clip kann sogar auf die ganze 
Datei verweisen. Das bedeutet, dass Sie Clips nach 
der AudioSuite-Bearbeitung über die gerenderte 
Selektion hinaus trimmen können.

So rendern Sie einen Clip mit AudioSuite-Handles:

1 Selektieren Sie das Audiomaterial, das Sie 
rendern möchten.

2 Wählen Sie aus dem AudioSuite-Menü das 
AudioSuite-Plug-In, das Sie verwenden 
möchten.

3 Stellen Sie die AudioSuite-Plug-In-Optionen 
und -Einstellungen ein.

4 Sie haben folgende Möglichkeiten:

• Geben Sie im Handle Length-Feld einen Wert 
für die Handle-Länge (0,00 bis 60,00 Sekunden) 
ein. Die Standard-Handle-Länge wird im 
Voreinstellungen-Dialogfeld eingestellt.

• Aktivieren Sie die Whole-File-Option, um die 
gesamte Datei zu rendern. Beachten Sie, dass 
nur die aktuelle Edit-Selektion in der Timeline 
erscheinen wird.

5 Klicken Sie auf Render.

Die Selektion wird als neuer Clip gerendert, 
dessen Dauer genauso lang ist wie die Selektion. 
Der Clip kann jedoch auf die festgelegte Handle-
Länge erweitert werden.

Setzen Sie bei der Bearbeitung eines einzelnen 
Audiokanals mit AudioSuite das Plug-In in 
den Mono-Modus (sofern verfügbar).

Handle-Länge-Feld im AudioSuite-Plug-In-Fenster

AudioSuite-Plug-In-Fenster, Whole-File-Option 
aktiviert
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Voreinstellungen für die AudioSuite-
Standard-Handle-Länge

Pro Tools verfügt über zwei Voreinstellungen 
zum Festlegen der Standardlänge für AudioSuite-
Handles. 

So legen Sie die Standardlänge für AudioSuite-
Handles fest:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Processing-Registerkarte.

3 Wählen Sie unter AudioSuite eine der 
folgenden Optionen:

• Whole-File – Standardeinstellung; rendert die 
gesamte Datei, die durch die Selektion 
referenziert wird.

• Länge – Standardeinstellung; rendert die Selektion 
sowie zusätzliches Audio bis zur festgelegten 
Handle-Länge (0,00 bis 60,00 Sekunden)

4 Klicken Sie auf OK.

AudioSuite-Plug-Ins in Stereo
Manche AudioSuite-Plug-Ins können sowohl 
für Mono als auch für Stereo verwendet werden. 
Wenn Sie im Stereomodus damit arbeiten 
möchten, beachten Sie Folgendes:

 Um eine Monospur in eine Stereospur 
umzuwandeln, wählen Sie die Spur oder den Clip 
und eine leere Spur oder einen leeren Clip aus. 
Schalten Sie anschließend das Plug-In in den 
Stereomodus und klicken Sie auf die Sum Inputs-
Schaltfläche (falls diese vorhanden ist), um das 
Originalsignal zu zentrieren. Wenn Sie das 
Audiomaterial bearbeiten, erhalten Sie zwei 
Spuren oder Clips, die die rechten und linken 
Kanäle des bearbeiteten Audiomaterials darstellen. 
Pannen Sie diese Spuren nun in Ihrer Mischung 
ganz nach rechts bzw. ganz nach links. 

 Wenn Sie im Stereomodus eine ungerade Anzahl 
von Pro Tools-Spuren für die Bearbeitung 
auswählen, bearbeitet das Plug-In die ausgewählten 
Spuren paarweise in Stereo. Jedoch wird bei einer 
ungeraden Anzahl an Spuren die letzte Spur in 
Mono und mit den Einstellungen des linken Kanals 
des Stereo-Plug-Ins bearbeitet. Wenn Sie auch diese 
Spur in Stereo bearbeiten möchten, wählen Sie eine 
zusätzliche (notfalls auch eine leere) Spur aus. Standard-Handle-Länge in den Bearbeitungs-

Voreinstellungen, Abschnitt AudioSuite
Weitere Informationen finden Sie unter 
„Channel Mode-Schaltfläche“ auf Seite 894.
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Bedingungen für das AudioSuite-Rendering mit Handles, 
Fades, Clip-Gain und Metadaten
Die meisten AudioSuite-Plug-Ins verfügen über mehrere Optionen für das Rendern von Clips. Nicht alle 
Einstellungen ermöglichen jedoch das Erstellen von AudioSuite-Handles. Beispiel: AudioSuite-Handles 
sind nicht im Modus „Gesamte Auswahl“ möglich, da es das Ziel dieser Option ist, die gesamte Selektion 
zu rendern. Fades und Crossfades sowie Clip-Gain-Einstellungen werden beibehalten oder gerendert, 
je nach Dateimodus und den Einstellungen für den AudioSuite-Rendering-Modus. Zusätzlich können 
Clip-Metadaten für gerenderte Clips unter bestimmten Bedingungen beibehalten werden. Diese 
Bedingungen sind nachstehend aufgeführt.

Bedingungen für die Erstellung von Handles und die Beibehaltung von Fades, Clip-Gain und Metadaten beim 
AudioSuite-Rendering

Dateimodus
Renderin
g-Modus

Handle-
Verhalten

Whole-
File

Fades Clip-Gain Metadaten

Dateien 
überschreiben

Clip für Clip Keine 
Handles

Nicht 
verfügbar

Beibehalten Beibehalten Beibehalten

Dateien 
überschreiben

Gesamte 
Auswahl

Keine 
Handles

Nicht 
verfügbar

Gerendert Gerendert Beibehalten

Einzelne 
Dateien

Clip für Clip Handles 
erstellt

Folgende Beibehalten Beibehalten Beibehalten

Einzelne 
Dateien

Gesamte 
Auswahl

Keine 
Handles

Nicht 
verfügbar

Gerendert Gerendert Beibehalten

Fortlaufende 
Datei

Clip für Clip Handles am 
Anfang und 
Ende der 
fortlaufenden 
Datei

Nicht 
verfügbar

Gerendert Gerendert Nicht 
beibehalten

Fortlaufende 
Datei

Gesamte 
Auswahl

Handles am 
Anfang und 
Ende der 
fortlaufenden 
Datei

Nicht 
verfügbar

Gerendert Gerendert Nicht 
beibehalten

Manche Plug-Ins, die beim Bearbeiten auf die Edit-Selektion angewiesen sind (einschließlich Plug-
Ins, die einen Analysedurchgang erfordern), funktionieren mit Handles vielleicht nicht wie erwartet. 
In diesen Fällen wird empfohlen, die Handle-Länge auf null zu setzen.

Destruktive Aufnahme und DestructivePunch-Aufnahme wird bei mit AudioSuite gerenderten Clips mit 
Handles nicht unterstützt.
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Kapitel 40: Elastic Audio

Elastic Audio umfasst eine spurbasierte Time 
Compression/Expansion (TCE), in Echtzeit oder 
gerendert, sowie eine Clip-basierte 
Tonhöhenänderung (Transposition). Pro Tools 
Elastic Audio verwendet besonders leistungsstarke 
Algorithmen für die Feststellung von Signalspitzen 
und die Tempo- und Schlaganalyse sowie 
Algorithmen für TCE in Echtzeit und zur 
Bearbeitung von Tonhöhenänderungen. Mit Elastic 
Audio können Sie schnell und einfach die Tonhöhe 
von Audioclips transponieren und Audio (einen 
Beat) an die Tempo-Map der Session anpassen. 
Elastic Audio bietet auch eine beispiellose 
Kontrolle über die Feststellung von Signalspitzen 
und die TCE-Bearbeitung für jedes einzelne Event.

Mit Elastic Audio analysiert Pro Tools komplette 
Audiodateien in Hinblick auf Signalspitzen. 
Ein Event kann beispielsweise ein Trommelschlag, 
eine erklingende Note oder ein mit einer Gitarre 
gespielter Akkord sein. Die ermittelten 
Signalspitzen können dann als Kontrollpunkte für 
das Audio-Warping genutzt werden. In Pro Tools 
können (TCE-)Audio-Events automatisch 
angepasst werden. Audiomaterial kann 
beispielsweise automatisch an das Session-Tempo 
angeglichen werden, Audio-Events können 
quantisiert werden und Audiomaterial kann manuell 
über Standard-Bearbeitungswerkzeuge in der 
Warp-Darstellung angepasst werden.

Elastic Audio ist bei den folgenden häufig 
verwendeten Arbeitsabläufen hilfreich: Arbeiten 
mit Loops, Korrigieren von Performances, 
Remixing, Sounddesign, Spezialeffekte und 
Unterlegen von Filmen mit Musik. 

Arbeiten mit Loops

Wenn Sie mit Loops arbeiten, können Sie in 
Elastic Audio Ihre Schleifen in Workspace-
Browsern in ihrem ursprünglichen Tempo (BPM) 
oder im Tempo der Session (BPM) vorhören. 
Die Loop kann sogar vorgehört werden, während 
die Session wiedergegeben wird. Wenn Sie die 
gewünschte Loop finden, ziehen Sie sie vom 
Browser in die Session. Der Loop wird 
automatisch an die Tempo-Map und das Bar|Beat-
Raster der Session angeglichen. Sie können 
anschließend das Timing verändern und den Clip 
transponieren, um ihn an die Tonhöhe anderer 
Loops in Ihrer Session anzupassen.

Korrigieren von Performances

In Elastic Audio können Sie Audiomaterial so 
quantisieren, dass eine Performance gestrafft wird, 
oder eine Note, die etwas zu spät wiedergegeben 
wird, erneut manuell ausrichten. Vielleicht finden 
Sie die Performance auch ausgezeichnet und nur 
ein wenig zu langsam. Mit dem tickbasierten 
Elastic Audio wird Audiomaterial automatisch an 
Tempoänderungen angepasst. Wenn Sie Ihre 
Spuren in tickbasiert ändern und das Session-
Tempo erhöhen, wird das Audiomaterial 
automatisch entsprechend komprimiert.

Remixing

Mit Elastic Audio können ganze Songs schnell an 
das Session-Tempo und das Bar|Beat-Raster 
angeglichen werden. Sie können auch Clips 
transponieren, um sie an die Tonhöhe anzupassen.
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Sounddesign und Spezialeffekte

Elastic Audio kann für Spezialeffekte mit 
extremer bzw. stark variabler TCE- oder 
Tonhöhenmanipulation verwendet werden. 
Verwenden Sie den Varispeed-Algorithmus, 
um Tape-ähnliche Effekte für Geschwindigkeits- 
und Tonhöhenänderungen zu erzielen.

Unterlegen von Filmen mit Musik

Wenn Sie eine Filmszene mit Musik unterlegen, 
können Sie Elastic Audio verwenden, um die 
Musik an die erforderliche Dauer anzupassen. 
Sie können sogar Tempoänderungen verwenden, 
um Accelerandos und Ritardandos zu erzielen.

Beispiel für einen Elastic 
Audio-Workflow
In diesem Arbeitsablauf werden Sie in einige der 
grundlegenden Aufgaben in Elastic Audio beim 
Arbeiten mit Loops eingeführt:

• Erstellen und Konfigurieren einer neuen Session

• Suchen Sie eine Loop und geben Sie sie in einem 
Workspace-Browser im Session-Tempo wieder:

• Importieren der Loop im Session-Tempo in eine 
tickbasierte, Elastic Audio-fähige Spur

• Ändern des Session-Tempos, um das Tempo des 
Clips in tickbasierten, Elastic Audio-fähigen 
Spuren zu ändern

• Quantisieren des Audiomaterials, um eine 
Groove-Vorlage auf den Rhythmus anzuwenden

• Transponieren des Clips, um die Tonhöhe 
des importierten Audiomaterials an andere 
Audiodaten und MIDI-Daten in der Session 
anzupassen

Erstellen und Konfigurieren einer neuen Session

1 Erstellen Sie eine neue Pro Tools-Session.

2 Stellen Sie die Haupt-Zeitbasis-Leiste auf 
Bars|Beats ein. 

3 Achten Sie darauf, dass die Tempo- und Meter-
Leisten angezeigt werden. 

4 Verwenden Sie das Standardtempo von 
Viertelnoten (120 BPM).

Suchen Sie eine Loop und geben Sie sie in einem 
Workspace-Browser im Session-Tempo wieder:

1 Öffnen Sie den Workspace (Window > 

Workspace).

2 Navigieren Sie zu dem Ordner, in dem Ihre 
Schlagzeug-Loops gespeichert sind. 
Doppelklicken Sie auf den Ordnernamen, 
um ein Browser-Fenster mit dem Inhalt des 
Ordners zu öffnen.

Bedenken Sie, dass sich bei Verwendung von 
Tempoanpassungen für Sessions mit 
mehreren Cues Tempo-Änderungen auf die 
Timecode-Position anderer Cues später in 
der Timeline auswirken können.

Elastic Audio ist nicht für Pull-Up- und Pull-
Down-Vorgänge geeignet. Verwenden Sie 
stattdessen die Echtzeit-Pull-Ups oder -Pull-
Downs im Session Setup-Fenster bzw. die im 
Lieferumfang von Time Shift- oder X-Form-
AudioSuite-Plug-Ins enthaltenen 
Voreinstellungen.
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3 Wählen Sie die Loop, die Sie in der Vorschau 
wiedergeben möchten.

4 Klicken Sie auf die Preview-Schaltfläche, 
um die Loop im ursprünglichen Tempo in der 
Vorschau wiederzugeben.

5 Klicken Sie auf die Audio Files Conform to 
Session Tempo-Schaltfläche, sodass diese 
markiert ist. 

6 Klicken Sie erneut auf die Preview-
Schaltfläche; daraufhin wird die Datei im 
Session-Tempo in der Vorschau wiedergegeben.

7 Wenn die Loop zu Beginn samplebasiert war, 
wird die Dauer der Datei nach der Analyse in 
Takten und Schlägen und nicht in Minuten oder 
Sekunden gemessen, das Samplebasiert-
Symbol wird durch das Tickbasiert-Symbol 
ersetzt und das erfasste Tempo der Datei wird in 
der Tempo-Spalte angezeigt.

8 Wiederholen Sie die vorherigen Schritte, 
um weitere Loops im Session-Tempo in der 
Vorschau wiederzugeben.

Importieren der Loop im Session-Tempo:

1 Vergewissern Sie sich, dass die Audio Files 
Conform to Session Tempo-Schaltfläche nach 
wie vor markiert ist. Dadurch wird 
sichergestellt, dass die Datei als tickbasierter 
Elastic Audio-Clip importiert wird und an das 
Session-Tempo angeglichen werden kann.

2 Ziehen Sie die Loop aus dem Browser und 
legen Sie sie in der Tracks-Liste im Edit-Fenster 
der Session ab.

Abhörpfade für die Vorschau werden im 
I/O Setup-Fenster ausgewählt (wählen Sie 
„Setup > I/O“ und klicken Sie auf die 
Output-Registerkarte).

Preview- und Audio Files Conform to Session Tempo-
Schaltflächen in einem Workspace-Browser

Audio Files Conform to Session 
Tempo-SchaltflächeVorhören-Schaltfläche

Elastic Audio-Steuerelemente und Anzeigen im 
Workspace

Wenn auf der Processing Preferences-
Registerkarte „All Files“ als Drag and Drop 
From Desktop Conforms to Session Tempo-
Option ausgewählt ist, können Sie auch per 
Drag & Drop Audiodateien vom Desktop 
ziehen und ablegen; diese werden als 
tickbasierte Elastic Audio-Dateien 
importiert.

Symbol für 
tickbasierte Datei

Dauer

Erkanntes 
Tempo

Symbol für 
samplebasierte Datei
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3 Es passiert Folgendes:

• Wenn keine Spuren in der Session vorhanden 
sind und die Datei tickbasiert ist, werden Sie 
aufgefordert, entweder das Tempo aus der 
Datei zu importieren oder das Session-Tempo 
zu verwenden. Um das Session-Tempo 
beizubehalten und zu erreichen, dass die 
Loop an das Session-Tempo angeglichen 
wird, klicken Sie auf Don't Import. 

• Wenn Spuren in der Session vorhanden sind, 
wird die Datei importiert und automatisch an das 
Session-Tempo angepasst.

4 Es wird eine neue tickbasierte Audiospur mit 
dem standardmäßigen aktivierten Elastic 
Audio-Plug-In erstellt.

5 Da Sie sich entschieden haben, das ursprüngliche 
Tempo der Datei nicht zu importieren, werden Sie 
feststellen, dass die Loop an die Tempo Map und 
das Bar|Beat-Raster der Session angeglichen wird. 
Sowohl im Clip in der Spur als auch in der 
Clipliste ist eine Warp-Anzeige zu sehen. 

Achten Sie darauf, dass es in der Clipliste zwei 
Clips gibt. Einer ist der Sample-basierte Whole-
File-Clip (die importierte Quelldatei) und der 
andere ist die Tick-basierte, mit Elastic Audio 
bearbeitete Kopie.

Sie können Clips auf Elastic Audio-fähigen 
Spuren auch mithilfe des Conform to 
Tempo-Befehls an das Session-Tempo 
angleichen (siehe „An Tempo angleichen“ 
auf Seite 804).

Drag & Drop einer tickbasierten Audiodatei aus einem Workspace-Browser in die Tracks-Liste

Neue tickbasierte 
Spur mit aktiviertem
Elastic Audio
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Ändern des Session-Tempos, um das Tempo des 
Clips zu ändern:

1 Ändern Sie das Tempo vom Standardwert 
120 BPM in 110 BPM (siehe „Tempo“ auf 
Seite 799).

2 Da sich der Clip auf einer tickbasierten, Elastic 
Audio-fähigen Spur (Echtzeit) befindet, wird er 
automatisch an das neue Tempo angeglichen.

Quantisieren des Audiomaterials zur Anwendung 
einer Groove-Vorlage:

1 Wählen Sie den Clip in der Tick-basierten, 
Elastic Audio-fähigen Spur (Echtzeit) aus.

2 Wählen Sie Event > Event Operations > 

Quantize.

3 Vergewissern Sie sich, dass im What to 
Quantize-Bereich die Elastic Audio Events-
Option aktiviert ist.

4 Wählen Sie im Quantize Grid-Popup-Menü eine 
Groove-Vorlage.

5 Stellen Sie ggf. weitere Optionen ein.

6 Klicken Sie auf Apply.

7 Achten Sie in der nächsten Abbildung darauf, 
dass das Audiomaterial entsprechend der 
ausgewählten Groove-Vorlage quantisiert wurde. 
In der Warp-Darstellung können Sie sehen, dass 
an jedem Event-Marker in der Nähe des 
Quantisierungsrasters Warp-Marker hinzugefügt 
und zur Anwendung der Quantisierung auf diese 
Events verwendet wurden. 

Importierte tickbasierte Audiodatei mit Elastic Audio-Bearbeitung

Warp-Anzeige

Tickbasierter, mit Elastic 
Audio bearbeiteter Clip

Samplebasierter 
Whole File-Clip

Ändern des Standardtempos
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Transponieren des Audioclips um einen Ganzton 
nach unten:

1 Wählen Sie den Clip in der Elastic Audio-
fähigen Spur aus.

2 Wählen Sie Event > Event Operations > 

Transpose.

3 Wählen Sie die Transpose By-Option.

4 Geben Sie „–2“ Halbtöne ein.

5 Klicken Sie auf Apply.

Quantisierte Audio-Events (Warp-Marker) in der Warp-Darstellung
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Elastic Audio-Spuren
Sie können eine Audiospur in Ihrer Pro Tools-
Session für Elastic Audio aktivieren. Elastic 
Audio-Spuren können entweder sample- oder 
tickbasiert sein. Bei samplebasierten Elastic 
Audio-fähigen Spuren können Sie eine Elastic 
Audio-Bearbeitung in Echtzeit bzw. eine 
gerenderte Elastic Audio-Bearbeitung anwenden, 
indem Sie die Warp-Darstellung bearbeiten, 
die Quantisierung anwenden und das TCE-Trim-
Tool verwenden. Es wird jedoch nur bei 
tickbasierten Elastic Audio-Spuren automatisch 
eine Elastic Audio-Bearbeitung basierend auf 
Tempoänderungen in der Session angewendet.

Aktivieren von Elastic Audio-
Spuren
So aktivieren Sie Elastic Audio für eine Spur:

1 Erstellen Sie eine neue Audiospur oder wählen 
Sie eine vorhandene Audiospur aus.

2 Klicken Sie auf den Elastic Audio-Plug-In-
Selektor der Spur und wählen Sie das 
entsprechende Elastic Audio-Plug-In für das 
Spurmaterial sowie die gewünschten 
Ergebnisse aus dem Popup-Menü aus: 
Polyphonic, Rhythmic, Monophonic, Varispeed 
oder X-Form (siehe „Elastic Audio-Plug-Ins“ 
auf Seite 913). 

Alle Audioclips auf der Spur werden 
vorübergehend offline geschaltet, wenn sie 
analysiert werden. Wenn die Analyse 
abgeschlossen ist, werden sie wieder online 
geschaltet. Die Wellenform von Audioclips, 
die für die Elastic Audio-Analyse offline sind, 
erscheint ausgegraut.

Bei der Aufnahme einer Elastic Audio-fähigen 
Spur in Echtzeit wird, sobald die Aufnahme 
beendet wird, das neu aufgezeichnete 
Audiomaterial offline geschaltet, während es 
analysiert wird. Wenn die Analyse abgeschlossen 
ist, wird es wieder online geschaltet.

Damit alle neuen Spuren tickbasiert sind, 
müssen Sie die New Tracks Default To Tick 
Timebase-Option in den Editing-
Voreinstellungen aktivieren. 

Beim Erstellen neuer Spuren per Drag & 
Drop von Audiomaterial aus einem 
Workspace-Browser (bei aktivierter Audio 
Files Conform to Session Tempo-Option) 
erstellt Pro Tools tickbasierte Elastic Audio-
fähige Spuren, unabhängig davon, ob die 
mittels Elastic Audio analysierte Datei tick- 
oder samplebasiert ist. Wenn die Option 
„Audio Files Conform to Session Tempo“ 
nicht aktiviert ist, werden in Pro Tools 
normale samplebasierte Spuren erstellt.

Bei Pro Tools HD kann Elastic Audio für 
Voices nicht verwendet werden. Verwenden 
Sie die dynamische Voice-Zuweisung für 
Spuren, bei denen Sie Elastic Audio 
verwenden möchten. (In Pro Tools wird nur 
die dynamische Voice-Zuweisung 
unterstützt; einzelne Voices können nicht 
zugewiesen werden.)

Elastic Audio-Plug-In-Popup-Menü
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3 Wählen Sie aus dem Elastic Audio-Plug-In-
Popup-Menü der Spur die Option Real-Time 
Processing bzw. Rendered Processing für eine 
gerenderte Elastic Audio-Bearbeitung bzw. eine 
in Echtzeit aus. 

Erstellen von neuen Spuren, 
wenn Elastic Audio aktiviert ist
Neue Spuren werden (mit automatisch aktiviertem 
Elastic Audio) in den folgenden Fällen erstellt:

• wenn die Option Enable Elastic Audio On New 
Tracks auf der Processing Preferences-
Registerkarte aktiviert ist (siehe „Elastic Audio-
Optionen“ auf Seite 338)

• wenn tickbasierte, in Elastic Audio analysierte 
Dateien aus Workspace-Browsern in die Tracks-
Liste oder in den leeren Bereich im Edit-Fenster 
gezogen bzw. dort abgelegt werden, und die 
Option Audio Files Conform to Session Tempo 
aktiviert ist (siehe „Elastic Audio beim Import“ 
auf Seite 331)

• wenn REX- oder ACID-Dateien vom Desktop 
(wenn in den Processing-Voreinstellungen 
entweder die Option REX and ACID Files Only 
oder All Files für die Drag and Drop from 
Desktop Conforms to Session Tempo-
Einstellung aktiviert ist) oder aus einem 

Workspace-Browser (wenn die Audio Files 
Conform to Session Tempo-Schaltfläche 
aktiviert ist) in die Tracks-Liste oder den leeren 
Bereich im Edit-Fenster gezogen und dort 
abgelegt werden (siehe „Importieren von ACID- 
und REX-Dateien“ auf Seite 335)

Deaktivieren von Elastic 
Audio-Spuren
So deaktivieren Sie Elastic Audio für eine Spur:

1 Wählen Sie mit dem Elastic Audio-Plug-In-
Selektor der Spur None – Disable Elastic Audio.

2 Wenn die Spur mit Elastic Audio bearbeitet 
wurde, werden Sie aufgefordert, eine der 
folgenden Aktionen auszuführen: Cancel, 
Revert oder Commit.

Abbrechen. – Elastic Audio bleibt für die Spur 
aktiviert.

Revert. – alle Elastic Audio-Bearbeitungen 
werden entfernt und Clips auf der Spur werden in 
ihre ursprüngliche Dauer zurückgesetzt; Elastic 
Audio wird für die Spur deaktiviert.

Commit. – rendert und speichert die Elastic Audio-
Bearbeitung auf der Spur, schreibt neue Dateien 
auf die Festplatte und deaktiviert Elastic Audio 
für die Spur.

Gespeicherte Clips
Clips, die entweder durch Deaktivieren von Elastic 
Audio für eine Spur oder durch Verschieben eines 
Clips auf eine Spur (Elastic Audio deaktiviert) 
gespeichert werden, werden als neue Audiodateien 
auf die Festplatte geschrieben. Diese neuen 
Audiodateien beinhalten das Audiomaterial im 
Clip mit Fades sowie, falls verfügbar, zusätzlich 
5 Sekunden Audiomaterial vor und nach dem Clip. 

Die Elastic Audio-Bearbeitung kann in Echtzeit 
oder gerendert erfolgen. Die Elastic Audio-
Bearbeitung in Echtzeit erfolgt unmittelbar, 
nimmt jedoch mehr Systemressourcen in 
Anspruch. Die gerenderte Elastic Audio-
Bearbeitung erfolgt nicht in Echtzeit, benötigt 
jedoch weniger Systemressourcen. Wenn Sie 
auf einem System mit begrenzten Ressourcen 
arbeiten, sollten Sie die gerenderte Elastic 
Audio-Bearbeitung verwenden. Weitere 
Informationen finden Sie unter „Elastic Audio-
Bearbeitung in Echtzeit und gerenderte Elastic 
Audio-Bearbeitung“ auf Seite 912.
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Deaktivieren von Elastic Audio 
und alternativen Playlists
Das Deaktivieren von Elastic Audio für eine Spur 
wirkt sich auf alle Playlists auf der Spur aus. Alle 
Playlists auf der Spur werden gespeichert oder 
zurückgesetzt, je nachdem, welche Option Sie 
auswählen.

Steuerelemente für Elastic 
Audio-Spuren
Audiospuren verfügen über Steuerelemente zum 
Aktivieren von Elastic Audio, zum Auswählen des 
Elastic Audio-Plug-Ins und zum Auswählen der 
Elastic Audio-Bearbeitung (Echtzeit oder gerendert). 

Elastic Audio-Plug-In-Selektor. – wählt das 
Elastic Audio-Plug-In für die Elastic Audio-
Bearbeitung aus (siehe „Elastic Audio-Plug-Ins“ 
auf Seite 913). Sie können den Elastic Audio-
Plug-In-Selektor auch verwenden, um die Elastic 
Audio-Bearbeitung zu deaktivieren und eine 
Echtzeit-Bearbeitung bzw. gerenderte Bearbeitung 
auszuwählen (siehe „Elastic Audio-Bearbeitung 
in Echtzeit und gerenderte Elastic Audio-
Bearbeitung“ auf Seite 912).

Elastic Audio-Plug-In-Schaltfläche. – zeigt den 
Namen des ausgewählten Elastic Audio-Plug-Ins 
an. Klicken Sie auf die Elastic Audio-Plug-In-
Schaltfläche, um das Elastic Audio-Plug-In-
Fenster zu öffnen (siehe „Elastic Audio-Plug-Ins“ 
auf Seite 913).

Anzeige für Echtzeit- oder gerenderte 
Bearbeitung. – leuchtet auf, wenn die Elastic 
Audio-Bearbeitung in Echtzeit erfolgt, und 
erlischt, wenn die Elastic Audio-Bearbeitung 
gerendert ist (siehe „Elastic Audio-Bearbeitung 
in Echtzeit und gerenderte Elastic Audio-
Bearbeitung“ auf Seite 912).

Darstellung für Elastic Audio-
Spuren
Es gibt zwei spezielle Spurdarstellungen für 
Elastic Audio-fähige Spuren: Warp- und Analysis-
Darstellung.

Warp-Darstellung
In der Warp-Darstellung können Sie manuell einen 
Zeitsprung (Elastic Audio-Bearbeitung) für das 
Audiomaterial ausführen. In der Warp-Darstellung 
können Warp-Marker erstellt und bearbeitet 
werden. Wenn Sie Elastic Audio verwenden, 
um das Timing einer Performance zu korrigieren 
oder um Spezialeffekte zu erzielen, sollten Sie in 
der Warp-Darstellung arbeiten (siehe „Editieren in 
der Warp-Darstellung“ auf Seite 917).

Steuerelemente für Elastic Audio-Spuren

Elastic Audio-
Plug-In-Selektor

Anzeige für 
Echtzeit- 

oder 
gerenderte 
BearbeitungElastic Audio-Plug-

In-Schaltfläche
Track View-Popup-Menü
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Analysis-Darstellung
In der Analysis-Darstellung können Sie erfasste 
Event-Marker bearbeiten. In den meisten Fällen 
werden Sie die Analysis-Darstellung nicht 
benötigen. Bei Material ohne klare Signalspitzen 
können Sie jedoch in der Analysis-Darstellung 
arbeiten, um Event-Marker hinzuzufügen, deren 
Position zu ändern oder falsche Event-Marker zu 
löschen. Wenn Sie beispielsweise Elastic Audio 
verwenden, um das Timing einer Performance zu 
korrigieren, müssen Sie möglicherweise Event-
Marker in der Analysis-Darstellung hinzufügen, 
verschieben oder entfernen, um eine optimale 
Elastic Audio-Bearbeitung zu erzielen (siehe 
„Bearbeitung in der Analysis-Darstellung“ auf 
Seite 924). 

Elastic Audio-Analyse
Beim Aufnehmen, Einfügen, Verschieben oder 
Importieren von nicht analysiertem Audiomaterial in 
eine Elastic Audio-fähige Spur oder beim Aktivieren 
von Elastic Audio für eine vorhandene Audiospur 
wird das Audiomaterial in Pro Tools automatisch 
auf Signalspitzen analysiert. In der Waveform-
Darstellung wird die Wellenform anfangs 
abgeblendet dargestellt, da Clips während der Elastic 
Audio-Analyse offline geschaltet werden. Nachdem 
die Analyse abgeschlossen ist, wird das 
Audiomaterial wieder online geschaltet. Die Elastic 
Audio-Analyse ist dateibasiert, d. h., selbst wenn Sie 
mit einem kleinen Clip einer großen Datei arbeiten, 
wird die gesamte Audiodatei analysiert.

Bei der Elastic Audio-Analyse werden 
Signalspitzen in der Audiodatei erfasst. Diese 
Signalspitzen werden durch Event-Marker 
angezeigt. Event-Marker werden sowohl in der 
Warp- als auch in der Analysis-Darstellung 
angezeigt. Bei der Elastic Audio-Analyse wird 
auch das ursprüngliche Tempo der analysierten 
Audiodatei sowie die Dauer in Takten und 
Schlägen berechnet.

Die Daten der Elastic Audio-Analyse 
(erfasste Signalspitzen, Tempo und Dauer 
in Takten/Schlägen) werden mit der Datei 
gespeichert. In Workspace-Browsern werden 
analysierte Audiodateien durch ein Häkchen 
links neben dem Dateinamen angezeigt. Für 
diese Dateien werden die Dauer in Bars|Beats, 
die Zeitbasis als Schläge und das ursprüngliche 
Tempo in BPM angezeigt.

Tempoerfassung
Bei der Elastic Audio-Analyse kann ein 
regelmäßigesTempo für das gesamte analysierte 
Audiomaterial erfasst werden. Audiomaterial mit 
einem normalen, regelmäßigen Rhythmus kann 
in Hinblick auf Tempo und Dauer in Takten und 
Schlägen analysiert werden. Analysierte Dateien, 
in denen ein Tempo erfasst wurde, werden als 
tickbasierte Dateien behandelt. Tickbasierte 
Dateien können für die Vorschau und den Import 
an das Session-Tempo angeglichen werden.

Analysierte Dateien, in denen kein Tempo erfasst 
wurde, werden als samplebasierte Dateien 
behandelt. Wenn es nur eine Signalspitze in der 
Datei gibt (etwa bei einem einzigen Snare-Schlag), 
wird kein Tempo erfasst. Auch bei größeren 
Dateien mit Tempoänderungen oder Rubato 
oder bei Dateien, die keine regelmäßigen 
Rhythmusmuster aufweisen, wird mit großer 
Wahrscheinlichkeit kein Tempo erfasst, 
und diese Dateien werden als samplebasierte 
Dateien behandelt.
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Event-Zuverlässigkeit
Signalspitzen werden mit einer bestimmten 
Zuverlässigkeit erfasst. Der Grad der 
Zuverlässigkeit basiert auf dem relativen Klarheit 
der Signalspitzen.

Ein Schlagzeug-Loop hat beispielsweise häufig 
klare, ausgeprägte Signalspitzen. Diese werden 
mit einem hohen Maß an Zuverlässigkeit erfasst. 
Eine Legato-Violinenmelodie weist jedoch keine 
klaren, ausgeprägten Signalspitzen auf; 
Signalspitzen werden daher mit einem geringen 
Maß an Zuverlässigkeit erfasst. 

In Pro Tools wird bei der Signalspitzenerfassung 
sehr aggressiv vorgegangen, sodass jedes Audio-
Event erfasst wird. Folglich kann es auch falsch 
erfasste Events geben. Diese Events werden mit 
einem niedrigen Maß an Zuverlässigkeit analysiert 
und können durch Herabsetzen der Event 
Sensitivity im Elastic Properties-Fenster 
herausgefiltert werden (siehe „Event Sensitivity“ 
auf Seite 928). Durch Herausfiltern von falschen 
Signalspitzen kann die Qualität der Elastic Audio-
Bearbeitung verbessert werden. 

Umgekehrt kann die Elastic Audio-Analyse 
Audio-Events bei Material mit wenig klaren 
Signalspitzen nicht präzise erfassen; diese werden 
mit einem niedrigen Maß an Zuverlässigkeit 
erfasst. In der Analysis-Darstellung können Event-
Marker ggf. verschoben oder hinzugefügt werden 
(siehe „Bearbeitung in der Analysis-Darstellung“ 
auf Seite 924). 

Ein langsames Synthesizer-Pad weist 
möglicherweise keine klaren Signalspitzen auf und 
die erfassten Event-Marker werden 
möglicherweise falsch positioniert oder wurden 
möglicherweise gar nicht erfasst. In der Analysis-
Darstellung können Sie Event-Marker bei Bedarf 
(etwa wenn sich der Akkord ändert) verschieben, 
entfernen und hinzufügen. Die korrekte 
Platzierung von Event-Markern führt zu besseren 
Ergebnissen bei der Anwendung der Elastic 
Audio-Bearbeitung.

Beachten Sie, dass die höchste Amplitude 
nicht der wichtigste Aspekt zur Messung der 
Event-Zuverlässigkeit ist. Die Klarheit von 
Signalspitzen wird zum Teil anhand des 
Spektralübergangs von einem Moment zum 
nächsten gemessen. Der Hochfrequenzanteil 
wird daher in Hinblick auf die Event-
Zuverlässigkeit bevorzugt. Eine Änderung 
der Event Sensitivity im Elastic Properties-
Fenster für einen ausgewählten Schlagzeug-
Loop führt beispielsweise dazu, dass die 
klareren Signalspitzen der Hi-Hat-Schläge 
höherer Frequenz eine höhere Event-
Zuverlässigkeit aufweisen als die weniger gut 
definierten Signalspitzen von Kick-Drum-
Schlägen niedrigerer Frequenz, obwohl 
Kick-Drum-Schläge eine höhere 
Spitzenamplitude haben.

Bei der Bearbeitung von nicht rhythmischem 
Audiomaterial (etwa Legato-Instrumente) 
mit dem Polyphonic-Plug-In führt eine 
Reduzierung der Anzahl von Event-Markern 
häufig zu einem besseren Klang. Sie können 
Event-Marker entweder in der Analysis-
Darstellung manuell entfernen (siehe 
„Bearbeitung in der Analysis-Darstellung“ 
auf Seite 924) oder die Event Sensitivity-
Einstellung im Elastic Properties-Fenster für 
den zu bearbeitenden Clip herabsetzen 
(siehe „Elastic Properties-Fenster“ auf 
Seite 927).
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Elastic Audio-Bearbeitung 
in Echtzeit und gerenderte 
Elastic Audio-Bearbeitung
Die Elastic Audio-Bearbeitung in Echtzeit 
bedeutet, dass alle Änderungen an der Elastic 
Audio-Bearbeitung (unabhängig davon, ob es sich 
um eine Tempoänderung, einen manuellen TCE-
Warp oder eine Tonhöhenänderung handelt) sofort 
wirksam werden. Die Elastic Audio-Bearbeitung 
in Echtzeit nimmt die Systemressourcen jedoch 
sehr in Anspruch. In manchen Fällen sollten Sie 
daher die gerenderte Elastic Audio-Bearbeitung 
verwenden. Bei der gerenderten Elastic Audio-
Bearbeitung werden bei einer Änderung an der 
Elastic Audio-Bearbeitung die betroffenen 
Audioclips vorübergehend offline geschaltet. 
Es wird eine neue gerenderte Audiodatei erstellt 
und alle betroffenen Audioclips werden wieder 
online geschaltet.

So stellen Sie eine Elastic Audio-Spur auf „Real-
Time“ oder „Rendered“ ein:

1 Klicken Sie auf den Elastic Audio-Plug-In-
Selektor der Spur.

2 Wählen Sie aus dem Popup-Menü ein Elastic 
Audio-Plug-In aus.

3 Wählen Sie aus dem Popup-Menü eine der 
folgenden Optionen:

• Real-Time Processing 

• Rendered Processing 

Informationen zu gerenderten 
Dateien
In Pro Tools werden temporäre Dateien für die 
gerenderte Elastic Audio-Bearbeitung erstellt. 
Diese Dateien werden in dem automatisch 
erstellten Rendered Files-Ordner im Session-
Ordner gespeichert. Wenn Sie die gerenderte 
Elastic Audio-Bearbeitung in einer Spur 
speichern, wird eine neue Datei auf die Festplatte 
in den Audio Files-Ordner gespeichert und die 
temporäre gerenderte Datei, aus der diese 
erstellt wurde, wird aus dem Rendered Files-
Ordner gelöscht.

Im gerenderten Modus werden alle 
vorgenommenen Änderungen mithilfe des 
Originalmaterials gerendert, um einen 
Generationsverlust aufgrund mehrerer 
aufeinanderfolgender Bearbeitungen zu 
vermeiden.

Wählen Sie die Echtzeit-Bearbeitung für die 
tickbasierte Elastic Audio-Bearbeitung 
(etwa Tempoänderungen). Die gerenderte 
Audiobearbeitung kann für die 
samplebasierte Elastic Audio-Bearbeitung 
hilfreich sein oder wenn Sie die 
Systemressourcen schonen müssen.

Elastic Audio-Plug-In-Selektor und -Popup-Menü

Um zwischen der Elastic Audio-Bearbeitung 
in Echtzeit und der gerenderten Bearbeitung 
umzuschalten, klicken Sie bei gedrückter 
Strg- und Windows-Taste (Windows) bzw. 
Befehls- und Ctrl-Taste (Mac) auf die Elastic 
Audio-Plug-In-Schaltfläche.
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Übersteuerungsanzeige
(Nur gerenderte Bearbeitung)

Da die gerenderte Elastic Audio-Bearbeitung nicht 
in Echtzeit erfolgt, werden Übersteuerungen 
aufgrund der Elastic Audio-Bearbeitung im Elastic 
Audio-Plug-In-Fenster nicht wiedergegeben. 
Bei Übersteuerungen aufgrund der gerenderten 
Elastic Audio-Bearbeitung wird in dem Clip 
stattdessen links neben der Warp-Anzeige eine 
Übersteuerungsanzeige für die Elastic Audio-
Bearbeitung angezeigt. 

Um Übersteuern bei der Wiedergabe zu 
vermeiden, verringern Sie die 
Eingangsverstärkung für den Clip im Elastic 
Properties-Fenster (siehe „Elastic Properties-
Fenster“ auf Seite 927).

Elastic Audio-Plug-Ins
Pro Tools stellt mehrere Algorithmen für die 
spurbasierte Elastic Audio-Bearbeitung in Echtzeit 
und die gerenderte Elastic Audio-Bearbeitung 
bereit. Durch das ausgewählte Elastic Audio-Plug-
In wird bestimmt, wie das Audiomaterial 
bearbeitet wird. Jedes Plug-In verwendet 
unterschiedliche Algorithmen für die Elastic 
Audio-Bearbeitung. Die unterschiedlichen 
Algorithmen sind für unterschiedliche 
Audiomaterialtypen geeignet. Wählen Sie das 
Plug-In aus, dessen Algorithmus für das Material 
auf der zu bearbeitenden Spur geeignet ist.

Elastic Audio-Plug-Ins haben ihren eigenen 
Selektor, der nur im Edit-Fenster verfügbar ist. 
Elastic Audio-Plug-Ins können nicht in Spur-
Inserts eingefügt werden. 

Elastic Audio-Plug-Ins verfügen über wenige bis 
keine anpassbaren Parameter. Die anpassbaren 
Steuerelemente sind ggf. im Elastic Audio-Plug-
In-Fenster verfügbar. Elastic Audio-Plug-In-
Parameter können nicht automatisiert werden.

So rufen Sie das Elastic Audio-Plug-In-
Fenster auf:

 Klicken Sie auf die Elastic Audio-Plug-In-
Schaltfläche.

Übersteuerungsanzeige für Elastic Audio

Übersteuerungsanzeigen
für Elastic Audio

Warp-Anzeige

Elastic Audio-Plug-In-Schaltfläche
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Steuerelemente im Elastic 
Audio-Plug-In-Fenster
Das Elastic Audio-Plug-In-Fenster bietet eine 
Reihe von Steuerelementen im Kopfbereich 
des Fensters, die für alle Elastic Audio-Plug-Ins 
gleich sind.

Track-Selektor. – hier können Sie auf eine andere 
Audiospur in der Session zugreifen.

Plug-In-Selektor. – hier können Sie Elastic Audio-
Plug-Ins auswählen oder Elastic Audio 
deaktivieren.

Plug-In Settings-Menü. – ermöglicht das 
Kopieren, Einfügen, Speichern und Importieren 
von Plug-In-Einstellungen.

Plug-In Librarian-Menü. – ruft die Einstellungsdateien 
(Voreinstellungen) für Elastic Audio-Plug-Ins wieder 
auf, die im Settings-Ordner im Verzeichnis des Plug-
Ins oder der aktuellen Session gespeichert wurden.

Schaltflächen für die nächste (+) und vorherige 
(–) Einstellung. – ermöglichen die Auswahl der 
nächsten bzw. vorherigen Einstellung im Plug-In 
Librarian-Menü.

Einstellungsauswahl-Schaltfläche. – ruft das 
Plug-In Settings-Dialogfeld auf, in dem die 
Voreinstellungen für das aktuelle Plug-In 
aufgeführt sind. Aus dieser Liste können Sie eine 
neue Voreinstellung auswählen oder eine Reihe 
von Voreinstellungen abhören.

Vergleich. – schaltet zwischen der gespeicherten 
ursprünglichen Plug-In-Einstellung und den von 
Ihnen vorgenommenen Änderungen um, um einen 
Vergleich zu ermöglichen.

Target-Schaltfläche. – wenn mehrere Elastic 
Audio-Plug-In-Fenster geöffnet sind, wählen 
Sie durch Klicken auf diese Schaltfläche das 
betreffende Plug-In als Ziel für Tastaturbefehle. 
Durch Aufheben der Auswahl der Target-
Schaltfläche kann ein weiteres Elastic Audio-Plug-
In-Fenster geöffnet werden.

Polyphonic-Plug-In
Das Polyphonic-Plug-In ist ein allgemeiner, 
universell einsetzbarer Algorithmus, der für ein 
breites Spektrum von Material verwendet werden 
kann. Verwenden Sie das Polyphonic-Plug-In bei 
komplexen Loops und Mischungen mit mehreren 
Instrumenten. Das Polyphonic-Plug-In unterstützt 
die clipbasierte Tonhöhenänderung.

Elastic Audio-Plug-In-Steuerelemente

Librarian-Menü

Track-Selektor Settings-Menü
Ziel-

Schaltfläche

Plug-In-Selektor

Nächste Einstellung

Compare-Schaltfläche
Einstellungsauswahl-Schaltfläche

Vorherige Einstellung

Wenn Sie die aktuellen Plug-In-Einstellungen 
vor Verwenden der Schaltflächen für die 
nächste und vorherige Einstellung nicht 
speichern, gehen sie verloren. Speichern Sie 
Ihre Plug-In-Einstellungen mithilfe des Plug-
In Settings-Menüs als Voreinstellungen.

Das Polyphonic-Plug-In ist das Standard-
Plug-In für die Vorschau und das Importieren 
aus Workspace-Browsern oder der Clipliste.
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Follow

Durch Auswählen der Follow-Option wird 
eine Hüllkurvenverfolgung aktiviert, die die 
ursprüngliche Akustik des zu streckenden 
Audiomaterials simuliert. Klicken Sie auf die 
Follow-Schaltfläche, um die Hüllkurvenverfolgung 
zu aktivieren bzw. zu deaktivieren.

Window

Das Polyphonic-Plug-In umfasst ein einziges 
Steuerelement zur Anpassung der Größe des 
Analysefensters für die TCE-Bearbeitung. 
Experimentieren Sie mit der Anpassung der 
Window-Größe für unterschiedliche Materialtypen, 
bis Sie ein optimales Ergebnis erzielen. 
Die folgende Tabelle enthält empfohlene Window-
Größen für unterschiedliche Materialtypen.

Rhythmic-Plug-In
Das Rhythmic-Plug-In ist am besten für Material 
mit klaren Attack-Signalspitzen geeignet, etwa für 
Schlagzeug. Das Rhythmic-Plug-In unterstützt die 
Clip-basierte Tonhöhenänderung.

Decay Rate

– ermittelt, welcher Teil der Dämpfung von einer 
Signalspitze in dem bearbeiteten Audiomaterial 
beim Dehnen gehört wird. Wenn das Rhythmic-
Plug-In ausgewählt ist, werden alle Lücken 
zwischen Signalspitzen, die aus der Dehnung 
resultieren, mit Audiomaterial gefüllt. Durch die 
Decay Rate wird bestimmt, welcher Anteil von 
diesem Audiomaterial gehört wird, indem ein Fade-
Out erzeugt wird. Stellen Sie die Decay Rate auf 
100 % ein, um das Audiomaterial, das die durch 
die Dehnung erzeugten Lücken füllt, mit einem 
geringen Fade-Out zu hören, oder stellen Sie sie auf 
1,0 % ein, um ein vollständiges Fade-Out zwischen 
den ursprünglichen Signalspitzen zu erzeugen.

Elastic Audio-Plug-In: Polyphonic

Wenn Sie häufig mit anderen Materialtypen 
arbeiten, sollten Sie die optimalen Window-
Einstellungen für den jeweiligen Materialtyp 
herausfinden und diese als Plug-In-
Einstellungen für einen schnellen und 
einfachen Zugriff speichern.

Materialtyp Empfohlene Fenster-Größe

Generell 30–40 ms

Perkussiv 20 ms oder niedriger

Pads und anderes 
Legato-Material

60 ms oder höher

Elastic Audio-Plug-In: Rhythmic
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Monophonic-Plug-In
Das Monophonic-Plug-In ist am besten für 
monophones Material geeignet, bei dem die 
Beziehungen zwischen Formanten unberührt 
bleiben sollen, etwa bei Gesang. Es eignet sich 
auch für monophone Instrumentallinien, etwa 
Bass-Spuren. Das Monophonic-Plug-In weist 
keine Plug-In-spezifischen Parameter auf.

Varispeed-Plug-In
Verwenden Sie das Varispeed-Plug-In, um Zeit- 
und Tonhöhenänderungen für bandähnliche 
Effekte für Geschwindigkeitsänderungen 
und Postproduktionsabläufe zu koppeln. 
Das Varispeed-Plug-In weist keine Plug-In-
spezifischen Steuerelemente auf.

X-Form-Plug-In
(Nur gerenderte Bearbeitung)

Das Elastic Audio-Plug-In X-Form ist eine 
modifizierte Version des unabhängigen 
AudioSuite-Bearbeitungs-Plug-Ins X-Form 
(basierend auf dem Radius®-Algorithmus von 
iZotope). Das Elastic Audio-Plug-In X-Form ist 
nur für die gerenderte Elastic Audio-Bearbeitung 
geeignet und kann nicht in Echtzeit oder als 
AudioSuite-Plug-In verwendet werden. 
Es liefert den qualitativ hochwertigsten 
Zeitkomprimierungsalgorithmus für 
Musikproduktions-, Sounddesign- und Audio-
Loop-Anwendungen. Mit ihm können Sie Audio-
Loops zur Tempoanpassung bearbeiten oder 
Gesangsspuren mithilfe der formantenkorrekten 
Tonhöhenkorrektur ändern.

Elastic Audio-Plug-In: Monophonic

Die Tonhöhenänderung für Elastic Audio 
wird mit dem Monophonic-Algorithmus 
nicht unterstützt.

Das Monophonic-Plug-In analysiert Tonhöhen 
und Signalspitzen, um eine qualitativ 
hochwertigere TCE für in der Tonhöhe 
geändertes Material zu liefern. Die Analyse 
durch den Monophonic-Algorithmus dauert 
daher länger als bei den Polyphonic-, Rhythmic- 
und Varispeed-Algorithmen. Bei einem Wechsel 
von einem anderen Elastic Audio-Plug-In zum 
Monophonic-Plug-In wird in Pro Tools jegliches 
Audiomaterial in der Spur erneut analysiert, um 
die zusätzlichen Analysedaten zu erfassen.

Elastic Audio-Plug-In: Varispeed

Verwenden Sie das Varispeed-Plug-In mit 
der Quantize-Option bei Schlagzeug-Loops, 
um interessante Effekte zu erzielen.
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Quality

Wählen Sie aus dem Quality-Popup-Menü entweder 
Maximum oder Low (Faster). Maximum ist zwar der 
langsamste Bearbeitungsalgorithmus, liefert aber die 
hochwertigsten Ergebnisse. Low (Faster) liefert 
verhältnismäßig gute Ergebnisse und arbeitet viel 
schneller als die Maximum-Einstellung.

Formant

Aktivieren Sie bei Audiomaterial mit klaren 
Formanten die Formant-Option, um die 
Formantform des Audiomaterials bei der TCE-
Bearbeitung beizubehalten.

Editieren in der Warp-
Darstellung
In der Warp-Darstellung können Sie manuell 
einen Zeitsprung für das (TCE-)Audiomaterial 
ausführen, um das Timing einer Performance 
zu korrigieren oder anzupassen oder um einen 
Spezialeffekt zu erzeugen. In der Warp-Darstellung 
können Warp-Marker hinzugefügt, verschoben und 
gelöscht werden. Warp-Marker werden verwendet, 
um eine bestimmte Position in dem Audiomaterial 
(in der Regel eine erfasste Signalspitze) mit einem 
bestimmten Punkt in der Timeline zu verbinden. 
Auf diese Weise kann ein detailliertes Warping von 
(TCE-)Audio-Events angewendet werden.

So zeigen Sie die Warp-Darstellung an:

1 Klicken Sie auf den Track View-Selektor der 
Elastic Audio-fähigen Spur.

2 Wählen Sie im Track View-Popup-Menü die 
Warp-Option.

Elastic Audio-Marker in der 
Warp-Darstellung
In der Warp-Darstellung sind drei Typen von 
Markern sichtbar: Event-Marker, Warp-Marker 
und durch Tempo-Events generierte Warp-
Marker. Verwenden Sie Event-Marker und Warp-
Marker als Kontrollpunkte für die Anwendung der 
Elastic Audio-Bearbeitung. 

Elastic Audio-Plug-In: X-Form

Audiomaterial mit einer Grundschwingung 
weist eine Reihe bzw. eine Gruppe von 
Obertönen auf. Die Stärke dieser 
hochfrequenten Obertöne erzeugt eine 
Formantenform, die bei Verwendung eines 
Spektrum-Analysators ersichtlich wird. 
Die Obertonreihen weisen den gleichen 
Abstand zu der Tonhöhenänderung und die 
gleiche allgemeine Form auf, unabhängig 
von der Grundschwingung. Durch die 
Formantenform erhält das Audiomaterial 
seinen charakteristischen Gesamtklang bzw. 
seine charakteristische Klangfarbe. Bei der 
Tonhöhenänderung von Audiomaterial 
wird die Formantenform mit dem 
restlichen Material geändert, was zu einem 
unnatürlichen Klang führen kann. Für eine 
korrekte Tonhöhenänderung und ein 
natürliches Klangergebnis ist es wichtig, 
dass diese Form konstant erhalten bleibt.

Die Warp-Darstellung ist nur für Elastic 
Audio-fähige Spuren verfügbar.

Elastic Audio-Marker in der Warp-Darstellung

Event-Marker
Tempo-Event-Warp-MarkerWarp-Marker
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Event-Marker
Event-Marker zeigen erfasste (oder manuell 
erstellte) Audio-Events an. Sie werden nur in der 
Warp-Darstellung und in der Analysis-Darstellung 
angezeigt. In der Warp-Darstellung werden Event-
Marker als graue vertikale Linien dargestellt, 
die sich nicht ganz bis an den Anfang oder das 
Ende der Spur erstrecken. Mit dem Grabber-Tool 
können Sie in der Warp-Darstellung Event-Marker 
so ziehen, dass unterschiedliche Arten von 
Warping in Abhängigkeit davon angewendet 
werden, ob in dem Clip auch Warp-Marker 
vorhanden sind. Event-Marker können in der 
Warp-Darstellung nicht hinzugefügt, verschoben 
oder gelöscht werden. Verwenden Sie die 
Analysis-Darstellung, um Event-Marker zu 
bearbeiten (siehe „Bearbeitung in der Analysis-
Darstellung“ auf Seite 924).

Warp-Marker
Mit Warp-Markern wird das Audiomaterial an 
bestimmten Punkten in der Timeline verankert. 
Warp-Marker werden nur in der Warp-Darstellung 
angezeigt. Ein Warp-Marker wird in der Warp-
Darstellung als dicke vertikale Linie mit einem 
Dreieck an der Basis dargestellt.

Um die Funktionsweise von Warp-Markern besser 
zu verstehen, stellen Sie sich den Audioclip als 
Gummiband, die Timeline als Lineal und die 
Warp-Marker als Nadel vor. Warp-Marker können 
verwendet werden, um eine bestimmte Stelle des 
Gummibands (des Audiomaterials) mit einem 
bestimmten Punkt auf dem Lineal (der Timeline) 
zu verbinden. Wenn Sie einen Punkt des 
Gummibands mit einem anderen Punkt auf dem 
Lineal verbinden, verwenden Sie eine zweite 

Nadel, um einen weiteren Punkt auf dem 
Gummiband mit einem weiteren Punkt auf dem 
Lineal zu verbinden. Platzieren Sie dann eine dritte 
Nadel in der Mitte zwischen diesen beiden Nadeln 
auf dem Gummiband, verbinden Sie diese jedoch 
mit einem Punkt auf dem Lineal, der sich näher an 
der zweiten Nadel befindet. Das Gummiband wird 
zwischen der ersten und der mittleren Nadel 
gedehnt (bzw. erweitert) und zwischen der 
mittleren und der letzten Nadel gelockert 
(komprimiert). 

In der Warp-Darstellung können Warp-Marker 
(ohne Warping) hinzugefügt, verschoben und 
gelöscht werden. Ein Warp-Marker kann zur 
Anwendung der Elastic Audio-Bearbeitung auch 
verschoben werden (siehe „Warpen von 
Audiomaterial“ auf Seite 920).

So fügen Sie einen Warp-Marker hinzu:

1 Vergewissern Sie sich, dass die Warp-
Darstellung aktiv ist.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie das Pencil-Tool aus und klicken Sie 
auf eine beliebige Stelle im Clip, um an dieser 
Stelle einen Warp-Marker hinzuzufügen. Wenn 
Sie auf einen Event-Marker klicken, wird 
zusätzlich zu dem Event-Marker ein Warp-
Marker erstellt.

• Wählen Sie das Grabber-Tool aus und klicken 
Sie bei gedrückter Ctrl-Taste (Mac) oder 
Windows-Taste (Windows) auf eine beliebige 
Stelle im Clip, um an dieser Stelle einen Warp-
Marker hinzuzufügen. Wenn Sie auf einen 
Event-Marker klicken, wird zusätzlich zu dem 
Event-Marker ein Warp-Marker erstellt.

• Wenn in dem Clip keine Warp-Marker vorhanden 
sind bzw. nur vor der Stelle, an der Sie einen 
neuen Warp-Marker hinzufügen möchten, 
doppelklicken Sie mit dem Grabber-Tool auf 
einen Event-Marker, um über dem Event-Marker 
einen Warp-Marker hinzuzufügen.

Die Anzeige von Event-Markern ist vom 
horizontalen Zoom abhängig. Wenn Sie zu 
weit herausgezoomt haben, werden keine 
Event-Marker angezeigt. Zoomen Sie näher 
heran, um die Event-Marker anzuzeigen.
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• Wählen Sie das Grabber-Tool aus und 
doppelklicken Sie auf eine beliebige Stelle im 
Clip, an der kein Event-Marker vorhanden ist, 
um an dieser Stelle einen Warp-Marker 
hinzuzufügen.

• Wählen Sie das Grabber-Tool aus und klicken Sie 
in dem Clip auf einen beliebigen Event-Marker, 
der sich vor einem anderen vorhandenen Warp-
Marker befindet, um über diesem Event-Marker 
einen Warp-Marker hinzuzufügen.

• Klicken Sie mit einem Edit-Tool mit der rechten 
Maustaste auf eine beliebige Stelle im Clip und 
wählen Sie in dem Popup-Menü die Add Warp 

Marker-Option , um an dieser Stelle einen Warp-
Marker hinzuzufügen. Wenn eine Edit-Selektion 
vorhanden ist, werden die Warp-Marker am 
Anfang und am Ende der Auswahl hinzugefügt.

So ändern Sie die Position eines Warp-Markers 
(ohne Warping):

 Wählen Sie das Grabber- oder Pencil-Tool aus, 
ziehen Sie bei gedrückter Windows-Taste 
(Windows) oder Ctrl-Taste (Mac) einen Warp-
Marker an eine neue Position.

So löschen Sie einen Warp-Marker:

1 Vergewissern Sie sich, dass die Warp-
Darstellung aktiv ist.

2 Sie haben folgende Möglichkeiten:

• Doppelklicken Sie mit dem Grabber-Tool auf 
einen Warp-Marker.

• Klicken Sie mit dem Grabber oder Pencil-Tool 
bei gedrückter Alt- (Windows) bzw. Wahl-Taste 
(Mac) auf einen Warp-Marker.

• Klicken Sie mit einem Edit-Tool mit der rechten 
Maustaste auf einen Warp-Marker und wählen 
Sie in dem Popup-Menü die Remove Warp 

Marker-Option.

So löschen Sie alle Warp-Marker in einer Auswahl:

1 Nehmen Sie eine Edit-Selektion mit lediglich 
den Warp-Markern vor, die gelöscht werden 
sollen (und nicht den Warp-Markern, die Sie 
behalten möchten).

2 Sie haben folgende Möglichkeiten:

• Drücken Sie auf der Computertastatur die Entf- 
oder Rücktaste.

• Klicken Sie mit einem Edit-Tool mit der rechten 
Maustaste auf die Edit-Selektion und wählen Sie 
aus dem Popup-Menü die Remove Warp 

Marker-Option.

Tempo-Event-generierte Warp-
Marker
Tempo-Event-generierte Warp-Marker können 
nicht bearbeitet werden und werden nur angezeigt, 
um darauf hinzuweisen, wo die Elastic Audio-
Bearbeitung angewendet wurde, um das 
Audiomaterial an Tempo-Events anzupassen. 
Tempo-Event-generierte Warp-Marker werden 
nur für tickbasierte Spuren angezeigt.

Wenn Sie die Spur-Zeitbasis von Ticks zu Samples 
ändern, werden über Tempo-Events erzeugte 
Warp-Marker zu normalen, bearbeitbaren Warp-
Markern konvertiert.

Weitere Informationen finden Sie unter 
„Tempowechsel und tickbasierte Elastic 
Audio-Spuren“ auf Seite 804.
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Warpen von Audiomaterial
In der Warp-Darstellung können Sie Audiomaterial 
auf drei unterschiedliche Arten warpen: Teleskop-
Warp, Akkordeon-Warp und Bereichs-Warp. 

Teleskop-Warp
Ein Teleskop-Warp kann auf jeden beliebigen 
Audioclip vor oder hinter einem Warp-Marker 
angewendet werden, solange sich davor oder 
dahinter kein weiterer Warp-Marker befindet. 
Das Audiomaterial kann sich auf einer sample- 
oder tickbasierten Spur befinden. Ein Teleskop-
Warp ist besonders beim Anpassen von 
Audiodateien an die Tempo-Map und das 
Bar|Beat-Raster der Session hilfreich. 

So wenden Sie einen Teleskop-Warp auf einen 
Clip an:

1 Vergewissern Sie sich, dass die Warp-
Darstellung aktiv ist. 

2 Sie haben folgende Möglichkeiten:

• Wählen Sie das Grabber-Tool aus und ziehen Sie 
einen beliebigen Event-Marker, der sich hinter 
dem letzten Warp-Marker im Clip befindet, nach 
links oder rechts, um einen Teleskop-Warp auf 
das Audiomaterial anzuwenden, das sich hinter 
dem Warp-Marker befindet. Wenn sich in dem 
Clip kein Warp-Marker befindet, wird am 
Startpunkt des Clips automatisch einer erstellt. 
Der Startpunkt des Clips bleibt an seiner 
Position auf der Timeline verankert.

• Wählen Sie das Grabber-Tool aus und ziehen Sie 
bei gedrückter Alt- (Windows) bzw. Wahl-Taste 
(Mac) einen beliebigen Event-Marker, der sich 
vor dem letzten Warp-Marker in dem Clip 
befindet, nach links oder rechts, um einen 
Teleskop-Warp auf das Audiomaterial 
anzuwenden, das sich vor dem Warp-Marker 
befindet. Wenn sich in dem Clip kein Warp-
Marker befindet, wird am Endpunkt des Clips 
automatisch einer erstellt. Der Endpunkt des 
Clips bleibt an seiner Position auf der Timeline 
verankert.

Beispiel für einen Arbeitsablauf

Angleichen eines Songs mit einem Teleskop-Warp 
an das Session-Tempo und das Bar|Beat-Raster:

1 Vergewissern Sie sich, dass die Haupt-
Zeitbasis-Leiste auf „Bars|Beats“ festgelegt ist.

2 Legen Sie Standardtaktart und -tempo fest.

3 Wählen Sie den Grid-Modus.

4 Importieren Sie einen Song oder eine andere 
längere Audiodatei aus einem Workspace-
Browser.

5 Vergewissern Sie sich, dass Elastic Audio auf 
der Spur aktiviert ist. 

Die Automation richtet sich nicht nach 
dem manuellen Warping von Audioclips, 
einschließlich TCE-Trimming und 
Quantisierung von Elastic Audio. 
Die Automation richtet sich jedoch nach 
Tempoänderungen auf tickbasierten Spuren.

Vor und nach dem Warping, Teleskop-Warp mit 
fixiertem Start des Clips
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6 Wählen Sie die Warp-Darstellung.

7 Vergewissern Sie sich, dass sich auf dem Clip 
keine Warp-Marker befinden. Löschen Sie 
gegebenenfalls vorhandene Warp-Marker.

8 Fügen Sie dem ersten Schlag von Takt 1 im Clip 
mit dem Pencil-Tool einen Warp-Marker hinzu.

9 Ziehen Sie mit dem Grabber-Tool den einzelnen 
Warp-Marker auf den Takt in der Timeline, 
an der der erste Schlag der Audiodatei 
starten soll.

10 Ziehen Sie den Event-Marker auf den ersten 
Schlag von Takt 2 des Clips, um einen 
Teleskop-Warp auf das Audiomaterial 
anzuwenden, sodass der Event-Marker mit der 
entsprechenden Taktzahl im Bars|Beats-Ruler 
übereinstimmt.

11 Wenn das Tempo des Clips variiert, fügen Sie 
dem nächsten Downbeat beim Tempowechsel 
einen Warp-Marker hinzu und wiederholen Sie 
die vorherigen Schritte.

Akkordeon-Warp
Bei einem Akkordeon-Warp wird die Elastic Audio-
Bearbeitung auf beiden Seiten eines einzelnen Warp-
Markers in einem Clip angewendet. Auf diese Weise 
können Sie das Audiomaterial gleichmäßig auf 
beiden Seiten eines festen Punkts erweitern oder 
komprimieren. Ein Akkordeon-Warp ist sinnvoll für 
Audiodateien, bei denen der Downbeat in der Mitte 
des Clips liegt.

So wenden Sie einen Akkordeon-Warp auf einen 
Clip an:

1 Fügen Sie in der Warp-Darstellung einen 
einzelnen Warp-Marker an dem Punkt im Clip 
hinzu, der in der Timeline fixiert bleiben soll.

2 Ziehen Sie mit dem Grabber-Tool alle Event-
Marker vor oder nach dem einzelnen Warp-
Marker nach links oder rechts.

Bereichs-Warp
Bei einem Bereichs-Warp wird die Elastic Audio-
Bearbeitung zwischen zwei festen Punkten in 
einem Clip angewendet. Um ein Bereichs-Warp 
anzuwenden, müssen mindestens zwei Warp-
Marker in dem Clip vorhanden sein.

So wenden Sie einen Bereichs-Warp in einem 
Clip an:

1 Fügen Sie in der Warp-Darstellung einen Warp-
Marker an dem ersten Punkt ein, der auf der 
Timeline fixiert werden soll.

2 Fügen Sie an dem Endpunkt, der an der 
Timeline fixiert werden soll, einen weiteren 
Warp-Marker ein.

3 Ziehen Sie mit dem Grabber-Tool einen Event-
Marker zwischen den beiden Warp-Markern 
nach links oder rechts. Ein Warp-Marker wird 
zusätzlich zu dem Event-Marker hinzugefügt 
und das Audiomaterial wird auf beiden Seiten 
des gezogenen Markers komprimiert bzw. 
erweitert, während das Audiomaterial 
außerhalb der angrenzenden Marker 
unverändert bleibt.

Vor und nach dem Warping, Akkordeon-Warp auf 
einen Clip um einen festen Punkt herum
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Bereichs-Warp mit einer Edit-
Selektion
In Pro Tools können Sie einen Bereichs-Warp 
zwischen begrenzenden Warp-Markern anwenden, 
das Timing zwischen anderen Warp-Markern in 
einer Edit-Selektion bleibt jedoch unverändert.

So wenden Sie einen Bereichs-Warp mit einer Edit-
Selektion an:

1 Fügen Sie in der Warp-Darstellung einen Warp-
Marker an dem ersten Punkt ein, der auf der 
Timeline fixiert werden soll.

2 Fügen Sie an dem Endpunkt, der an der 
Timeline fixiert werden soll, einen weiteren 
Warp-Marker ein.

3 Fügen Sie eine beliebige Anzahl von Warp-
Markern zwischen diesen Punkten ein.

4 Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion vor, mit den Warp-Markern zwischen 
den begrenzenden Warp-Markern.

5 Ziehen Sie mit dem Grabber-Tool einen der 
Warp-Marker in der Edit-Selektion nach links 
oder rechts. 

Die Elastic Audio-Bearbeitung wird nur auf das 
Audiomaterial zwischen den begrenzenden Warp-
Markern sowie auf den ersten und letzten Warp-
Marker in der Edit-Selektion angewendet. 
Das Audiomaterial zwischen dem ersten und 
letzten Warp-Marker in der Edit-Selektion behält 
sein relatives Timing.

Einzelner Bereichs-Warp
Bei einem einzelnen Bereichs-Warp wird das 
Warping auf ein einzelnes Audio-Event in Bezug 
auf die angrenzenden Audio-Events angewendet.

So wenden Sie einen einzelnen Bereichs-Warp an:

1 Wählen Sie das Grabber-Tool aus und klicken 
Sie in der Warp-Darstellung bei gedrückter 
Umschalttaste auf einen Warp-Marker oder 
einen Event-Marker. An den angrenzenden 
Event-Markern werden, falls nichts bereits 
vorhanden, automatisch Warp-Marker erstellt.

2 Ziehen Sie den Cursor nach links oder rechts, 
um das ausgewählte Event zu warpen.

Vor und nach dem Warping, Bereichs-Warp zwischen 
zwei Warp-Markern in einem Clip

Vor und nach dem Warping, Bereichs-Warp auf eine 
Auswahl zwischen begrenzenden Warp-Markern
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Gewarpte Clips
Bei Clips, die manuell oder automatisch durch 
eine Tempoänderung, Quantisierung oder 
Tonhöhenänderung gewarpt wurden, wird eine 
Warp-Anzeige rechts oben im Clip angezeigt. 
Diese Anzeige ist in allen Spurdarstellungen 
sichtbar. Da sich nicht gewarpte Clips auf Elastic 
Audio-fähigen Spuren befinden, wird bei Clips auf 
Elastic Audio-fähigen Spuren nicht unbedingt die 
Warp-Anzeige angezeigt. Die Warp-Anzeige gibt 
nur an, dass die Elastic Audio-Bearbeitung auf 
einen Clip angewendet wurde.

Ausblenden der Warp-Anzeige
Die Warp-Anzeige für Elastic Audio-Clips kann 
ausgeblendet werden.

So blenden Sie die Warp-Anzeige in Elastic Audio-
Clips aus oder zeigen sie an:

 Aktivieren oder deaktivieren Sie View > Clip > 
Processing State.

Bearbeitung außerhalb des 
gültigen Bereichs
In Pro Tools können Sie extreme Werte für die 
Elastic Audio-Bearbeitung einstellen. Bei solchen 
extremen Werten wird jedoch möglicherweise der 
zulässige Bearbeitungsbereich des ausgewählten 
Elastic Audio-Plug-Ins überschritten. In diesem 
Fall wird möglicherweise nicht jedes Sample 
korrekt bearbeitet und es können Audio-Drop-
Outs auftreten.

Der gültige Bereich für die Elastic Audio-TCE-
Bearbeitung ist 1/4x bis 4x für alle Elastic Audio-
Plug-Ins, außer X-Form; dieses Plug-In unterstützt 
1/8x bis 8x. TCE-Werte, die größer oder kleiner 
als diese Bereiche sind, überschreiten den 
gültigen Bereich.

Wenn es zu einer Bearbeitung außerhalb des 
gültigen Bereichs kommt, wird der Abschnitt 
des Audioclips, der sich außerhalb des Bereichs 
befindet, rot angezeigt. Die Elastic Audio-
Bearbeitung kann nach wie vor angewendet 
werden, Sie werden jedoch durch die Farbänderung 
darauf hingewiesen, dass sich der TCE-Faktor 
außerhalb des normalen Bereichs der Elastic Audio-
Bearbeitung befindet.

Vor und nach dem Warping, einzelner Bereichs-Warp 

Warp-Anzeige in einem Clip in der Waveform-
Darstellung

TCE-Faktor außerhalb des gültigen Bereichs (rot)

Der TCE-Faktor im Elastic Properties-
Fenster unterstützt extreme Bereiche von 
1 bis 9.999 %. Alle Werte unter 25 bzw. über 
400 % befinden sich jedoch außerhalb des 
gültigen Bereichs und werden rot angezeigt.
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Entfernen eines Clip-Warpings
Wenn Sie ein Warping auf einen Clip angewendet 
haben, können Sie dieses entfernen und die 
ursprüngliche Länge des Clips wiederherstellen. 
Dies kann hilfreich sein, wenn Sie mit den 
Ergebnissen nicht zufrieden sind und den Clip wieder 
in den Zustand vor dem Warping zurückversetzen 
möchten. Warp-Marker werden nicht gelöscht, wenn 
der Remove Warp-Befehl ausgewählt wird, 
das Warping wird aber rückgängig gemacht.

So entfernen Sie Clip-Warping:

1 Wählen Sie den Clip, aus dem Sie das Warping 
entfernen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Remove Warp.

• Klicken Sie mit einem Edit-Tool mit der rechten 
Maustaste auf den Clip und wählen Sie aus dem 
Popup-Menü die Remove Warp-Option.

Edit-Gruppen und Warp-
Bearbeitung
Elastic Audio-fähige Spuren können in Edit-
Gruppen eingeschlossen werden. Bei Elastic 
Audio-fähigen Spuren, die Teil einer Edit-Gruppe 
sind, wird durch Anwenden der Elastic Audio-
Bearbeitung auf eine Spur diese ebenso auf alle 
anderen Spuren in der Edit-Gruppe angewendet. 

Wenn auf Elastic Audio-fähigen Spuren nicht 
bereits entsprechende Warp-Marker vorhanden 
sind, die Teil einer Edit-Gruppe sind, werden auf 
diesen Spuren neue Warp-Marker erstellt, wenn 
Sie einen Warp-Marker hinzufügen oder auf eine 
Spur verschieben, die Teil der Edit-Gruppe ist.

Bearbeitung in der Analysis-
Darstellung
In der Analysis-Darstellung können Event-Marker 
hinzugefügt, verschoben, gesperrt und gelöscht 
werden. In Pro Tools werden in der Regel alle 
Signalspitzen (Event-Marker) in einer Audiodatei 
korrekt erkannt und Sie müssen nicht in der 
Analysis-Darstellung arbeiten. Bei manchem 
Audiomaterial werden in Pro Tools jedoch 
möglicherweise nicht alle Audio-Events korrekt 
erfasst, oder manche Audio-Events werden 
irrtümlicherweise erfasst. Dies gilt insbesondere 
für Audiomaterial ohne klare Signalspitzen, etwa 
Legato-Instrumente, melismatischer Gesang oder 
Software-Synthesizers-Pads. 

Verwenden Sie die Analysis-Darstellung, um das 
Vorhandensein und die Position von Event-
Markern manuell zu korrigieren. Die korrekte 
Erkennung von Audio-Events führt zu besseren 
Ergebnissen bei der Anwendung der Elastic 
Audio-Bearbeitung.

So zeigen Sie die Analysis-Darstellung an:

1 Klicken Sie auf den Track View-Selektor der 
Elastic Audio-fähigen Spur.

2 Wählen Sie im Track View-Popup-Menü die 
Analysis-Option.

Die Remove Warp-Funktion kann nur auf 
Clips, nicht auf Clipgruppen angewendet 
werden. Um Warpings von Clipgruppen zu 
entfernen, müssen Sie die Clipgruppierung 
aufheben, die Remove Warp-Funktion auf die 
zugrunde liegenden Clips anwenden und 
anschließend diese Clips wieder neu 
gruppieren.

Die Analysis-Darstellung ist nur für Elastic 
Audio-fähige Spuren verfügbar.

In der Analysis-Darstellung können nur 
Analysis-Marker mithilfe der Edit-Tools 
bearbeitet werden. Sie können die Edit-Tools 
nicht für die Clipbearbeitung verwenden. 
Wechseln Sie zur Warp- oder Waveform-
Darstellung, um Clip-basierte 
Bearbeitungsfunktionen mit den Edit-Tools 
zu erhalten.



Kapitel 40: Elastic Audio 925

Hinzufügen von Event-Markern

So fügen Sie einen Event-Marker hinzu:

1 Vergewissern Sie sich, dass die Analysis-
Darstellung aktiv ist. 

2 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Pencil-Tool auf die Stelle, 
an der Sie einen Event-Marker hinzufügen 
möchten.

• Doppelklicken Sie mit dem Grabber-Tool auf 
die Stelle, an der Sie einen Event-Marker 
hinzufügen möchten.

• Wählen Sie das Grabber-Tool aus und klicken 
Sie bei gedrückter Ctrl-Taste (Mac) oder 
Windows-Taste (Windows) auf die Stelle, an der 
Sie einen Event-Marker hinzufügen möchten.

• Klicken Sie mit einem beliebigen Edit-Tool mit 
der rechten Maustaste auf die Stelle, an der Sie 
einen Event-Marker hinzufügen möchten und 
wählen Sie aus dem Popup-Menü die Add Event 

Marker-Option aus.

Verschieben von Event-Markern

So verschieben Sie einen Event-Marker:

1 Vergewissern Sie sich, dass die Analysis-
Darstellung aktiv ist.

2 Sie haben folgende Möglichkeiten:

• Ziehen Sie mit dem Pencil-Tool den Event-
Marker an die neue Position.

• Ziehen Sie mit dem Grabber-Tool den Event-
Marker an die neue Position.

Sperren von Event-Markern
Event-Marker werden mit einem relativen Grad an 
Zuverlässigkeit erfasst (zwischen 1 % und 100 %). 
Sie können irrelevante Event-Marker herausfiltern, 
indem Sie die Event Sensitivity-Einstellung im 
Elastic Properties-Fenster anpassen; die Event-
Marker mit der niedrigsten Zuverlässigkeit werden 
zuerst herausgefiltert. Möglicherweise werden 
jedoch einige wichtige Events nicht mit einem 
hohen Grad an Zuverlässigkeit erkannt. In diesem 
Fall bietet es sich an, die Event-Marker zu sperren, 
um sicherzustellen, dass sie beim Herabsetzen der 
Event Sensitivity-Einstellung nicht herausgefiltert 
werden. Gesperrte Event-Marker haben genau wie 
manuell erstellte oder verschobene Event-Marker 
eine Zuverlässigkeit von 100 %.

Wenn Sie Analysis-Marker manuell 
bearbeiten, werden in Pro Tools die 
temporären Elastic Audio-Analysedateien 
(.aan) in den Rendered Files-Ordner der 
Session geschrieben. Alle nicht verwendeten 
temporären Analysedateien werden gelöscht, 
wenn Sie die Session schließen.

Hinzufügen eines Event-Markers mit dem Pencil-Tool

Verschieben eines Event-Markers
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So sperren Sie einen Event-Marker:

 Klicken Sie mit dem Grabber- oder Pencil-Tool 
(oder mit dem Smart-Tool in der unteren Hälfte 
der Spur) in der Analysis-Darstellung auf den 
Event-Marker, den Sie sperren möchten. 

Löschen von Event-Markern

So löschen Sie einen Event-Marker:

1 Vergewissern Sie sich, dass die Analysis-
Darstellung aktiv ist. 

2 Sie haben folgende Möglichkeiten:

• Wählen Sie das Pencil-Tool und klicken Sie bei 
gedrückter Alt- (Windows) bzw. Wahl-Taste 
(Mac) auf den zu löschenden Event-Marker.

• Wählen Sie das Grabber-Tool und klicken Sie 
bei gedrückter Alt- (Windows) bzw. Wahl-Taste 
(Mac) auf den zu löschenden Event-Marker.

• Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion mit allen Event-Markern vor, 
die gelöscht werden sollen, und drücken 
Sie die Entf- oder Rücktaste.

• Nehmen Sie mit dem Selector-Tool eine Edit-
Selektion mit allen Event-Markern vor, 
die gelöscht werden sollen. Klicken Sie mit der 
rechten Maustaste auf die Auswahl und wählen 
Sie aus dem Popup-Menü die Remove Event 
Marker-Option.

Edit-Gruppen und Bearbeiten 
von Events
Elastic Audio-fähige Spuren können in Edit-
Gruppen eingeschlossen werden. Bei Elastic 
Audio-fähigen Spuren, die Teil einer Edit-Gruppe 
sind, wird die Bearbeitung von Event-Markern auf 
einer Spur ebenso auf alle anderen Spuren in der 
Edit-Gruppe angewendet.

Elastic-Eigenschaften
Jeder Clip in einer Elastic Audio-fähigen Spur 
weist spezielle Elastic Audio-Eigenschaften auf 
(etwa Tempo, Taktart, TCE-Faktor, 
Eingangsverstärkung und Tonhöhenänderung). 

Im Elastic Properties-Fenster können Sie die 
Eigenschaften für ausgewählte Clips anzeigen 
und ändern. Sie können beispielsweise die 
Eingangsverstärkung für die Elastic Audio-
Bearbeitung reduzieren, um Übersteuerungen zu 
verhindern, die während der Bearbeitung auftreten 
können.

Im Elastic Properties-Fenster können Sie auch Event-
Marker für Elastic Audio-Clips auf Tick-basierten 
Spuren filtern. Durch Filtern von Event-Markern 
kann die Qualität der Elastic Audio-Bearbeitung bei 
Material mit unklaren Signalspitzen verbessert 
werden.

So zeigen Sie das Elastic Properties-Fenster für 
einen Clip an:

1 Wählen Sie einen Clip in einer Elastic Audio-
fähigen Spur aus. Die Spur kann entweder 
sample- oder tickbasiert sein.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Elastic Properties. 

• Klicken Sie mit der rechten Maustaste auf den 
Clip und wählen Sie Elastic Properties aus.

Gesperrte Event-Marker sehen genauso aus 
wie erfasste Event-Marker. Um alle Event-
Marker mit 100 % Zuverlässigkeit 
anzuzeigen, setzen Sie die Event Sensitivity-
Einstellung im Elastic Properties-Fenster 
herab (siehe „Event Sensitivity“ auf 
Seite 928).

Löschen eines Event-Markers mit dem Pencil-Tool
Drücken Sie Alt + 5 (Windows) oder Wahl + 
5 (Mac) auf der numerischen Tastatur, 
um das Elastic Properties-Fenster zu öffnen.
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Elastic Properties-Fenster
Im Elastic Properties-Fenster werden Informationen 
über die Elastic Audio-Bearbeitung und -Analyse 
für einen oder mehrere Clips angezeigt. Sie können 
das Elastic Properties-Fenster verwenden, um die 
Elastic Audio-Bearbeitung und die Analysedaten 
anzupassen.

Im Elastic Properties-Fenster gibt es verschiedene 
Elastic Properties, je nachdem, ob die Spur 
tickbasiert oder samplebasiert ist. Wenn die Spur 
samplebasiert ist, wird ein reduzierter Satz von 
Elastic Audio-Eigenschaften angezeigt.

Clipeigenschaft
Die Clipeigenschaft zeigt den Namen des Clips an 
und gibt an, ob der Clip sich auf einer tick- oder 
samplebasierten Spur befindet. Wenn mehr als ein 
Clip ausgewählt ist, wird die Anzahl ausgewählter 
Clips angezeigt. Wenn Clips auf Tick- und auf 
Sample-basierten Spuren ausgewählt werden, 
werden die Eigenschaften nur begrenzt angezeigt.

Source Length (nur tickbasierte 
Spuren)
Die Source Length-Eigenschaft zeigt die Länge 
des Clips basierend auf der Quelldatei in Takten 
und Beats an. Wenn die Länge der Quelldatei 
falsch analysiert wurde, können Sie sie ändern. 

So ändern Sie die Source Length eines Clips:

1 Öffnen Sie das Elastic Properties-Fenster für 
den Clip.

2 Sie haben folgende Möglichkeiten:

• Geben Sie die korrekten Takt-, Schläge- und 
Tick-Werte in das Source Length-Feld ein.

• Wenn die Dauer fälschlicherweise als die halbe 
Dauer der Quelldatei analysiert wurde, klicken 
Sie auf die Schaltfläche x2.

• Wenn die Dauer fälschlicherweise als die 
doppelte Dauer der Quelldatei analysiert wurde, 
klicken Sie auf die Schaltfläche 1/2.

Source Tempo (nur tickbasierte 
Spuren)
Die Source Tempo-Eigenschaft zeigt das 
durchschnittliche Tempo der Quelldatei an, das 
basierend auf den erfassten Signalspitzen und der 
Länge der Datei berechnet wird. Wenn das Tempo 
der Quelldatei falsch analysiert wurde, können Sie 
es ändern.

So ändern Sie das Source Tempo eines Clips:

1 Öffnen Sie das Elastic Properties-Fenster für 
den Clip.

2 Wählen Sie den korrekten Notenwert für den 
Schlag aus dem Tempo Resolution-Popup-
Menü aus. Wenn die Quelldatei beispielsweise 
im 5/8-Takt ist, wählen Sie die 1/8-Note aus.

Elastic Properties, tickbasiert

Elastic Properties, samplebasiert

Durch Ändern der Dauer eines Clips auf 
einer Elastic Audio-fähigen Spur mithilfe des 
TCE-Trim-Tools wird die Source Length im 
Elastic Properties-Fenster aktualisiert.
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3 Sie haben folgende Möglichkeiten:

• Geben Sie das Tempo im Source Tempo-
Feld ein.

• Wenn das Tempo fälschlicherweise als das halbe 
Tempo der Quelldatei analysiert wurde, klicken 
Sie auf die Schaltfläche x2.

• Wenn das Tempo fälschlicherweise als das 
doppelte Tempo der Quelldatei analysiert 
wurde, klicken Sie auf die Schaltfläche 1/2.

Meter (nur tickbasiert)
Bei der Elastic Audio-Analyse wird nicht die 
Taktart berechnet, es wird davon ausgegangen, 
dass alle Dateien im 4/4-Takt sind. Wenn Sie mit 
anderen Taktarten als 4/4 arbeiten, verwenden Sie 
die Meter-Eigenschaft, um die Quelltaktart korrekt 
zu ermitteln.

So ändern Sie die Taktart eines Clips:

1 Öffnen Sie das Elastic Properties-Fenster für 
den Clip.

2 Klicken Sie in das Meter-Zählerfeld und geben 
Sie die korrekte Anzahl von Schlägen pro Takt 
ein. Wenn der Clip beispielsweise im 3/4-Takt 
ist, geben Sie 3 ein.

3 Klicken Sie das Meter-Nennerfeld und geben 
Sie den korrekten Notenwert ein. Wenn die 
Taktart beispielsweise im 6/8-Takt ist, geben 
Sie 8 ein.

TCE Factor
Die TCE Factor-Eigenschaft zeigt den Prozentwert 
der auf die Quelldatei angewendeten Änderung an. 
Bei tickbasierten Spuren dient diese Eigenschaft 
nur zur Anzeige und kann nicht bearbeitet werden. 
Auf Sample-basierten Spuren können Sie den 
TCE-Faktor ändern, um TCE auf den Clip 
anzuwenden. Der Prozentwert des TCE-Faktors 
wird immer in Bezug auf die Quelldatei berechnet. 

Der TCE Factor-Wert wird rot angezeigt, wenn bei 
der Elastic Audio-Bearbeitung der gültige Bereich 
überschritten wird (siehe „Bearbeitung außerhalb 
des gültigen Bereichs“ auf Seite 923).

Event Sensitivity
Mit der Event Sensitivity-Eigenschaft können 
Sie Event-Marker basierend auf dem 
Zuverlässigkeitsgrad der Analyse filtern. 
Der Zuverlässigkeitsgrad für alle erfassten 
Signalspitzen basiert teilweise auf der Klarheit der 
Signalspitze. Wenn es sich bei der Datei 
beispielsweise um einen Schlagzeug-Loop 
handelt, werden laute akzentuierte Schläge mit 
einem höheren Zuverlässigkeitsgrad analysiert als 
weiche unbetonte Schläge. 

Die Event Sensitivity-Eigenschaft dient als 
Schwellenwert für die Anzeige lediglich der 
Signalspitzen, die mit einem hohen 
Zuverlässigkeitsgrad erfasst wurden. In der Warp- 
oder Analysis-Darstellung werden Sie sehen, dass 
die Anzahl von Event-Markern ab- bzw. zunimmt, 
wenn Sie die Event Sensitivity reduzieren bzw. 
erhöhen. 

Eine Reduzierung der Event Sensitivity kann 
helfen, die Anzahl falsch erfasster Signalspitzen zu 
minimieren. Dies führt wiederum zu einer 
besseren Elastic Audio-Bearbeitung. In Pro Tools 
werden die erfassten Signalspitzen gespeichert, 
wenn TCE angewendet wird, um Flamming und 
Granulation der Signalspitzen zu vermeiden. 
Daher bleiben auch falsche Signalspitzen erhalten 
und die resultierende Klangqualität ist 
möglicherweise unerwünscht schlecht. Wenn Sie 
mit Audiomaterial arbeiten, das keine klar 
definierten Signalspitzen aufweist, sollten Sie die 
Event Sensitivity in den Elastic Properties 
reduzieren oder möglicherweise sogar die Event-
Marker in der Analysis-Darstellung bearbeiten.
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Eine Reduzierung der Event Sensitivity führt dazu, 
dass wichtige Event-Marker herausgefiltert 
werden. Sie können diese Event-Marker in der 
Analysis-Darstellung sperren (siehe „Sperren von 
Event-Markern“ auf Seite 925).

Reset-Schaltfläche
Klicken Sie auf die Reset-Schaltfläche im Elastic 
Properties-Fenster, um die Ereignisanalysedaten 
für den Clip zurückzusetzen und an die 
Originaldatei anzupassen. Die Event Sensitivity-
Eigenschaft wird auf 100 % zurückgesetzt.

Input Gain
Bei der Zeitkomprimierung von Audiomaterial 
kann es zu einer Übersteuerung kommen. Echtzeit-
Elastic-Audio-Plug-Ins umfassen eine 
Übersteuerungsanzeige, an der Sie erkennen 
können, ob eine Übersteuerung aufgetreten ist; 
die Elastic Audio-Plug-In-Schaltfläche wird rot 
angezeigt. In gerenderten Elastic Audio-Clips wird 
eine Übersteuerungsanzeige für den Clip 
angezeigt, falls es zur Übersteuerung kommt 
(siehe „Übersteuerungsanzeige“ auf Seite 913).

Wenn bei der Elastic Audio-Bearbeitung eine 
Übersteuerung auftritt, verwenden Sie die Input 
Gain-Eigenschaft im Elastic Properties-Fenster, 
um die Verstärkung des Audiosignals vor der 
Bearbeitung zu dämpfen.

Pitch Shift (nur Polyphonic, 
Rhythmic und X-Form)
Mit der Pitch Shift-Eigenschaft kann mithilfe 
der Polyphonic-, Rhythmic- oder X-Form-Plug-Ins 
die Tonhöhe ganzer Clips auf Elastic Audio-fähigen 
Spuren geändert werden. Die Tonhöhenänderung 
(in Echtzeit oder gerendert) wird in Halbtönen und 
Cents im Bereich von +/– 2 Oktaven angewendet.

Bei REX-Dateien werden die Slices von 
Pro Tools als Events mit 100 % 
Zuverlässigkeit konvertiert. Durch Ändern 
der Event Sensitivity-Einstellung von 99 % 
auf 1 % werden daher keine Events 
herausgefiltert, die auf Slices basieren. Wenn 
Sie die Event Sensitivity jedoch auf 0 % 
festlegen, werden alle Marker 
herausgefiltert.

Wenn Sie die Event Sensitivity-Eigenschaft 
ändern, werden in Pro Tools die temporären 
gefilterten Elastic Audio-Analysedateien 
(.aan) in den Rendered Files-Ordner der 
Session geschrieben. Alle nicht verwendeten 
temporären, gefilterten Analysedateien 
werden gelöscht, wenn Sie die Session 
schließen.
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Clipbasierte 
Tonhöhenänderungen mit 
Elastic Audio
(Nur Polyphonic, Rhythmic und X-Form)

Zusätzlich zu den Elastic Audio-TCE-Funktionen 
in Pro Tools können Sie auch die Tonhöhe ganzer 
Audioclips um Halbtöne und Cents im Bereich von 
+/– 2 Oktaven verändern. 

So ändern Sie die Tonhöhe eines Clips:

1 Stellen Sie sicher, dass sich die gewünschten 
Clips auf Spuren mit aktiviertem Elastic Audio 
befinden (und den Polyphonic-, Rhythmic- oder 
X-Form-Algorithmus verwenden).

2 Wählen Sie den entsprechenden Clip mit dem 
Grabber- oder Selector-Tool aus. Nur 
vollständig selektierte Clips sind von der 
Änderung betroffen.

3 Öffnen Sie das Elastic Properties-Fenster für 
den Clip.

4 Verändern Sie die Einstellungen für Pitch Shift 
um das gewünschte Maß in Halbtönen und 
Cents nach oben („+“) oder nach unten („–“).

So transponieren Sie die Tonhöhe eines Audio-
Clips im Transpose-Fenster:

1 Stellen Sie sicher, dass sich die zu 
transponierenden Clips auf Spuren mit 
aktiviertem Elastic Audio befinden (und den 
Polyphonic-, Rhythmic- oder X-Form-
Algorithmus verwenden).

2 Wählen Sie die entsprechenden Clips mit 
dem Grabber- oder Selector-Tool aus. 
Nur vollständig selektierte Clips sind von der 
Änderung betroffen.

3 Wählen Sie Event > Event Operations > 

Transpose.

Die Elastic Audio-Tonhöhenveränderung 
wird nicht im Zusammenhang mit dem 
Monophonic-Algorithmus unterstützt. Wenn 
Sie jedoch nach einer Tonhöhenänderung mit 
einem anderen Plug-In in das Monophonic-
Plug-In wechseln, bleiben die Metadaten der 
Tonhöhe für den Clip erhalten.

Die Tonhöhenänderung für Elastic Audio 
kann nicht auf Loop-Clips oder Clipgruppen 
angewendet werden.

Elastic Properties-Fenster

Event Operations, Transpose
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4 Sie haben folgende Möglichkeiten:

• Passen Sie die Transpose By-Einstellungen um 
einen Betrag in Halbtönen und Cents an.

• Passen Sie die Transpose From- und -To-
Einstellungen um einen Betrag in Halbtönen 
und Cents an.

5 Klicken Sie auf Apply.

Varispeed und 
Tonhöhenänderung
Bei Verwendung des Varispeed-Algorithmus sind 
Tonhöhenänderung und Time Compression/ 
Expansion immer miteinander verknüpft. Wenn 
Sie die Tonhöhenänderung eines Audioclips 
mithilfe des Polyphonic- oder Rhythmic-
Algorithmus vornehmen, werden die Daten der 
Transponierung in den Metadaten für den Clip 
gespeichert. Wenn Sie dann zu Varispeed 
wechseln, den TCE-Faktor ändern und 
anschließend zurück zum ursprünglichen Elastic 
Audio-Algorithmus wechseln, wird für den Clip 
wieder die ursprüngliche Tonhöheneinstellung 
hergestellt, während das durch den Varispeed-
Algorithmus angewendete Maß an Time 
Compression/Expansion beibehalten wird.

Rückgängigmachen der 
Tonhöhenänderung eines Clips
Wenn Sie die Tonhöhe eines Clips verändert 
haben, können Sie dies rückgängig machen und 
die ursprüngliche Tonhöhe des Clips 
wiederherstellen. Dies kann hilfreich sein, wenn 
Sie mit den Ergebnissen nicht zufrieden sind und 
den Clip wieder in den Zustand vor der 
Transponierung zurückversetzen möchten.

So machen Sie die Tonhöhenänderung eines Clips 
rückgängig:

1 Wählen Sie den Clip, aus dem Sie das Pitch-
Shifting entfernen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Clip > Remove Pitch Shift.

• Klicken Sie mit einem Edit-Tool mit der rechten 
Maustaste auf den Clip und wählen Sie die 
Remove Pitch Shift-Option.

AudioSuite-Bearbeitung und 
Elastic Audio-Clips
Die Elastic Audio-Bearbeitung in Echtzeit ist nicht 
destruktiv. Da AudioSuite-Plug-Ins jedoch den 
gesamten Clip bearbeiten und eine neue 
Audiodatei erstellen (bzw. eine destruktive 
Bearbeitung anwenden), werden beim Anwenden 
der AudioSuite-Bearbeitung auf Clips auf Elastic 
Audio-fähigen Spuren alle Elastic Audio-
Bearbeitungen zuerst gerendert. Die gerenderte 
Datei wird dann von AudioSuite bearbeitet und die 
resultierende neue Audiodatei wird für die Elastic 
Audio-Bearbeitung analysiert. 

Die Einstellungen „Transpose All Notes To“ 
und „Transpose In Key“ können nur auf 
MIDI-Noten angewendet werden. Wenn nur 
Audioclips ausgewählt sind, stehen diese 
Optionen nicht zur Verfügung. Die Remove Pitch Shift-Funktion kann nur 

auf Clips, nicht auf Clipgruppen angewendet 
werden. Um Tonhöhenänderungen von 
Clipgruppen rückgängig zu machen, 
müssen Sie die Clipgruppierung aufheben, 
die Remove Pitch Shift-Funktion auf die 
zugrunde liegenden Clips anwenden und 
anschließend diese Clips wieder neu 
gruppieren.
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Verschieben von Elastic Audio zwischen Spuren
Audiomaterial wird in Pro Tools auf unterschiedliche Weise analysiert, angepasst und gespeichert, wenn 
Audioclips zwischen Spuren verschoben werden, für die Elastic Audio aktiviert bzw. deaktiviert ist. 
Die folgende Tabelle zeigt unterschiedliche Ergebnisse für das Verschieben von Clips zwischen Spuren 
mit Elastic Audio-Verarbeitung in Echtzeit, gerenderten Spuren mit Elastic Audio-Verarbeitung und 
Audiospuren ohne Elastic Audio.

Verschieben von Elastic Audio zwischen Spuren

From So Ergebnis

Spur mit aktiviertem 
Elastic Audio in Echtzeit

Gerenderte Spur mit 
aktiviertem Elastic Audio

Rendern eines Clips mit Elastic Audio-Plug-In der 
Zielspur

Spur mit aktiviertem 
Elastic Audio in Echtzeit

Audiospur (kein Elastic 
Audio)

Rendern eines Clips mit Elastic Audio-Plug-In der 
Ausgangsspur und Speichern des Clips auf der Zielspur

Gerenderte Spur mit 
aktiviertem Elastic Audio

Spur mit aktiviertem 
Elastic Audio in Echtzeit

Anwenden der Elastic Audio-Bearbeitung in Echtzeit 
mithilfe des Elastic Audio-Plug-Ins der Zielspur

Gerenderte Spur mit 
aktiviertem Elastic Audio

Audiospur 
(kein Elastic Audio)

Auf Spur speichern

Audiospur 
(kein Elastic Audio)

Spur mit aktiviertem 
Elastic Audio in Echtzeit

Berechnen der Elastic Audio-Analyse und Anwenden 
der Elastic Audio-Bearbeitung in Echtzeit mithilfe des 
Elastic Audio-Plug-Ins der Zielspur

Audiospur 
(kein Elastic Audio)

Gerenderte Spur mit 
aktiviertem Elastic Audio

Berechnen der Elastic Audio-Analyse und Rendern des 
Clips mithilfe des Elastic Audio-Plug-Ins der Zielspur

In der Tonhöhe 
geänderte Spur mit 
aktiviertem Elastic Audio

Audiospur 
(kein Elastic Audio)

Rendern eines Clips mit Tonhöhenänderung mit Elastic 
Audio-Plug-In der Ausgangsspur und Speichern des 
Clips auf der Zielspur

Clips, die entweder durch Deaktivieren von Elastic Audio für eine Spur oder durch Verschieben eines 
Clips auf eine Spur (Elastic Audio deaktiviert) gespeichert werden, werden als neue Audiodateien auf die 
Festplatte geschrieben (siehe „Gespeicherte Clips“ auf Seite 908).
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Ungefähre Wellenformen
Bei der Elastic Audio-Bearbeitung in Echtzeit 
handelt es sich bei den Wellenformen nur um 
ungefähre Abbildungen. Wenn Sie beispielsweise 
eine in Echtzeit Elastic Audio-bearbeite Spur über 
einen Bus aufnehmen, werden Sie feststellen, 
dass die Wellenform auf der Quellspur der 
aufgenommenen Spur nicht exakt entspricht. 
Was Sie hören, ist jedoch eine präzise Wiedergabe 
der Elastic Audio-Bearbeitung in Echtzeit, auch 
dann, wenn die Wellenform auf der Quellspur nur 
eine ungefähre Abbildung ist.

Elastic Audio-
Voreinstellungen
Durch die Elastic Audio-Einstellungen in den 
Processing-Voreinstellungen wird bestimmt, 
welches Elastic Audio-Plug-In für die Vorschau 
und den Import verwendet wird und ob neue 
Spuren mit aktiviertem Elastic Audio mit dem 
ausgewählten Standard-Plug-In erstellt werden.

Default Plug-In. – mit dieser Option können 
Sie jedes Real-Time Elastic Audio-Plug-In als 
Standard-Plug-In für die Vorschau und das 
Importieren von Elastic Audio verwenden. 
Das ausgewählte Standard-Elastic-Audio-Plug-
In wird auch verwendet, wenn neue Spuren 
mit aktiviertem Elastic Audio erstellt werden. 
Der Elastic Audio-Plug-In-Selektor in 
Workspace-Browsern übernimmt die Einstellung 
des ausgewählten Standard-Plug-Ins. Durch 

Ändern des ausgewählten Plug-Ins in Workspace-
Browsern wird ebenso die Einstellung für das 
ausgewählte Standard-Plug-In in den Processing-
Voreinstellungen aktualisiert.

Default Input Gain. – hier können Sie den 
Signaleingang für Elastic Audio-Plug-Ins um 0 bis 
–6 dB für die Vorschau und den Import dämpfen. 
Wenn aufgrund der Elastic Audio-Bearbeitung 
während der Vorschau oder nach dem Import eine 
Übersteuerung auftritt, sollten Sie die Default 
Input Gain-Option so einstellen, dass der 
Audiosignaleingang für die Elastic Audio-
Bearbeitung leicht abgeschwächt wird. Diese 
Einstellung gilt auch für Audiomaterial, das in eine 
Elastic Audio-fähige Spur importiert wird.

Wenn Sie Clips auf einer Spur speichern (indem Sie 
Elastic Audio für die Spur deaktivieren), die mit der 
Eingangsverstärkung importiert wurden, wird die 
Clip-basierte Eingangsverstärkung 
auf 0 zurückgesetzt.

Das Elastic Properties-Fenster übernimmt die 
Einstellung der Default Input Gain-Option. 
Um eine weitere clipbasierte Eingangsverstärkung 
für die Elastic Audio-Bearbeitung anzuwenden, 
wählen Sie den Clip aus und passen Sie die Input 
Gain-Einstellung im Elastic Properties-Fenster an 
(siehe „Elastic Properties-Fenster“ auf Seite 927).

Enable Elastic Audio on New Tracks. – wenn 
diese Option ausgewählt ist, werden neue Spuren 
mit aktiviertem Elastic Audio erstellt. Das 
ausgewählte Elastic Audio-Standard-Plug-In wird 
verwendet.

Elastic Audio-Voreinstellungen

Wenn die Enable Elastic Audio on New 
Tracks-Option ausgewählt ist, können Sie 
auch die New Tracks Default to Tick 
Timebase-Option in den Editing-
Voreinstellungen auswählen.
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Kapitel 41: Event Operations

Verschiedene Events in Pro Tools (beispielsweise 
Gruppen von MIDI-Noten, Start- bzw. Sync-Punkte 
von Audioclips und ganze Clips) können mit der 
Event Operations-Funktion transformiert werden.

Event Operations-Fenster
Das Event Operations-Fenster enthält die Befehle, 
die Sie benötigen, um die Tonhöhe, das Timing 
und das Phrasing ganzer Gruppen von MIDI-
Noten zu ändern. Die Event Operations 
„Quantize“ und „Restore Performance“ können 
auch auf Startpunkte (bzw. Sync-Punkte) von 
Audioclips sowie für Elastic Audio-Events 
angewendet werden. Die Event Operation 
„Transpose“ kann auch auf ganze Clips auf Elastic 
Audio-fähigen Spuren angewendet werden.

Das Event Operations-Fenster verfügt über neun 
Seiten, eine für jeden Event Operations-Befehl.

• Quantize

• Editierungszustand wiederherstellen

• Editierungszustand speichern

• Velocity ändern

• Dauer ändern

• Transpose

• Noten auswählen/trennen

• Input Quantize

• Schrittweise Eingabe

Das Event Operations-Fenster kann geöffnet 
bleiben, um einen bestimmten Befehl anzuwenden 
oder verschiedene Optionen eines bestimmten 
Befehls auszuprobieren.

So öffnen Sie eine bestimmte Seite im Event 
Operations-Fenster:

 Wählen Sie Event > Event Operations, 
und klicken Sie danach auf eine der Event 
Operations (etwa Quantize).

Mithilfe von MIDI-Echtzeit-Eigenschaften 
können Sie auch Quantisierung, Länge und 
Verzögerung anwenden und nicht destruktive 
Transpositionen vornehmen. Siehe „MIDI-
Echtzeit-Eigenschaften“ auf Seite 726.

Event Operations-Fenster (Seite „Quantize“)
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So öffnen Sie die letzte aktive Seite des Event 
Operations-Fensters:

 Wählen Sie Event > Event Operations > Event 

Operations.

So wenden Sie einen Event Operations-Befehl an:

 Klicken Sie auf Apply oder drücken Sie die 
Enter-Taste auf dem Ziffernblock. Hierdurch 
wird der Befehl ausgeführt und das Fenster 
bleibt im Vordergrund.

 Drücken Sie die Eingabetaste (Windows) bzw. 
die Return-Taste (Mac). Dadurch wird der 
Befehl angewendet und das Fenster wird 
geschlossen.

So machen Sie einen Befehl im Event Operations-
Fenster rückgängig:

 Wählen Sie Edit > Undo.

Optionen im Event Operations-
Fenster
Gehen Sie folgendermaßen vor, um die Optionen 
im Event Operations-Fenster zu konfigurieren:

 Um vorwärts bzw. rückwärts durch die 
verschiedenen Felder zu springen, drücken Sie Tab 
bzw. Tab + Umschalt.

 Vergrößern oder verringern Sie die Werte in den 
ausgewählten Feldern mit der Nach-oben- oder 
Nach-unten-Pfeiltaste. Halten Sie diese Tasten 
gedrückt, um schnell durch die Werte zu scrollen.

 Ziehen Sie in einem ausgewählten Feld nach 
oben oder unten, um zu einem neuen Wert zu 
scrollen.

 Halten Sie die Strg- (Windows) bzw. 
Befehlstaste (Mac) gedrückt, während Sie eine 
feinere Auflösung für die Regler einstellen.

 Wenn die Eingabefelder für Tonhöhe und 
Velocity ausgewählt sind, spielen Sie eine Note auf 
der Tastatur Ihres MIDI-Controllers, um ihre 
Notenwerte automatisch einzugeben.

 Das Ändern eines Werts für ein bestimmtes 
Steuerelement (etwa „Swing Percentage“ im 
Quantize-Fenster) aktiviert dieses Steuerelement 
automatisch. 

Um das Event Operations-Fenster zu öffnen, 
drücken Sie Wahl + 3 (Mac) oder Alt + 3 
(Windows).

Wenn das Event Operations-Fenster bereits 
geöffnet ist, können Sie über das Popup-Menü 
oben im Fenster die gewünschte Seite 
ansteuern.

Bei gleichzeitiger Verwendung des Event 
Operations-Fensters und der MIDI-Echtzeit-
Eigenschaften werden Event Operations auf 
die effektiven MIDI-Daten angewendet. 
MIDI-Echtzeit-Eigenschaften werden 
zusätzlich zu den tatsächlichen MIDI-
Operationen angewendet.
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Quantize
Der Quantize-Befehl im Event Operations-Fenster 
kann auf MIDI-Noten, Audioclips und Elastic 
Audio-Events angewendet werden. Bei MIDI 
werden mit dem Quantize-Befehl Position und 
Dauer von MIDI-Noten so angepasst, dass das 
Timing verbessert oder ein besonderes 
rhythmisches Feeling erreicht wird. Bei 
Audioclips werden mit dem Quantize-Befehl die 
Startzeiten (oder Sync-Punkte) der Audioclips 
angepasst. Bei Elastic Audio wird mit dem 
Quantize-Befehl die Position von erfassten 
Signalspitzen angepasst und die Elastic Audio-
Verarbeitung entsprechend angewendet.

Mit dem Quantize-Befehl im Event Operations-
Fenster können Sie Grid Quantize basierend auf 
rhythmischen Werten (etwa einer 
Sechzehntelnote) oder mithilfe von Groove 
Quantize basierend auf Groove-Vorlagen 
anwenden. Für Grid Quantize und Groove 
Quantize gelten geringfügig andere Optionen.

Die Quantize Event Operation- und Quantize to 
Grid-Befehle können beide verwendet werden, um 
Clips zu quantisieren. Für die beiden Befehle gibt es 
jedoch jeweils eine weitere spezielle Verwendung.

Der Quantize to Grid-Befehl (Clip > Quantize to 
Grid) kann verwendet werden, um die Startpunkte 
(bzw. Sync-Punkte) für ausgewählte Clips 
anzupassen. Der Quantize to Grid-Befehl kann 
sowohl für MIDI- als auch für Audioclips 
angewendet werden (siehe „Quantisieren von 
Clips am Raster“ auf Seite 609).

Der Befehl „Quantize Event Operation“ hingegen 
kann, abgesehen von Startpunkten (bzw. Sync-
Punkten) von Audioclips, auf MIDI-Noten und 
Elastic Audio-Events separat angewendet werden. 
Manche Noten oder Events werden 
möglicherweise etwas nach hinten verschoben, 
andere etwas vorgezogen. Manche MIDI-Noten 
können verkürzt werden, andere jedoch verlängert 
und manche werden stärker verändert als andere.

So öffnen Sie das Quantize-Fenster:

 Wählen Sie „Event > Event Operations > 
Quantize“. 

So wählen Sie Grid Quantize:

 Wählen Sie im Quantize Grid-Popup-Menü 
einen Notenwert.

So wählen Sie Groove Quantize:

 Wählen Sie im Quantize Grid-Popup-Menü 
eine Groove-Vorlage.

Es kann auch MIDI-Input quantisiert werden, 
siehe „Input Quantize“ auf Seite 961.

Die Einstellungen im Quantize-Fenster 
werden mit jeder Session gespeichert. Um 
bevorzugte Einstellungen für zukünftige 
Sessions zu verwenden, speichern Sie sie als 
Bestandteil einer Session-Vorlage (siehe 
„Session-Vorlagen“ auf Seite 169). 

Drücken Sie Alt + 0 (Windows) oder Wahl + T 
(Mac), um das Quantize-Fenster zu öffnen.

Event Operations-Fenster, Quantize
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Mit Grid Quantize
Das Quantize-Fenster kann Grid Quantize 
anwenden, wenn im Quantize Grid-Popup-Menü 
ein bestimmter rhythmischer Wert gewählt ist. 
Wenn im Quantize-Popup-Menü eine Groove-
Vorlage gewählt ist, kann Groove Quantize 
angewandt werden. Weitere Informationen zu 
„Groove Quantize“ finden Sie unter „Groove 
Quantize“ auf Seite 943.

What to Quantize
Mit den What to Quantize-Einstellungen wird 
festgelegt, welche Aspekte der ausgewählten 
MIDI-Noten quantisiert werden: Notenanfang 
(Note On bzw. Attack), Notenende (Note Off bzw. 
Release) oder beide. Sie können auch auswählen, 
ob Audioclips oder Elastic Audio-Events 
quantisiert werden sollen. Je nachdem, welche Art 
von Spurmaterial ausgewählt wurde, sind nicht 
alle Optionen verfügbar. Wenn nur MIDI 
ausgewählt ist, sind die Optionen Audio Clips und 
Elastic Audio Events nicht verfügbar. Wenn nur 
Audio ausgewählt ist, sind die Optionen Note On, 
Note Off und Preserve Note Duration nicht 
verfügbar.

Note On. – wenn diese Option ausgewählt ist, 
werden die Anfangspunkte (Einschwingphasen) 
der MIDI-Noten quantisiert.

Note Off. – wenn diese Option ausgewählt ist, 
werden die Endpunkte (Ausschwingphasen) der 
MIDI-Noten quantisiert.

Preserve Note Duration. – wenn diese Option 
ausgewählt ist, bleibt die Dauer der MIDI-Noten 
erhalten. 

Wenn diese Option deaktiviert und die Note On-
Option ausgewählt ist, werden die Endpunkte der 
Noten nicht verschoben. 

Wenn diese Option deaktiviert und die Note Off-
Option ausgewählt ist, werden die Startpunkte der 
Noten nicht verschoben.

Wenn sowohl die Optionen Note On als auch Note 

Off ausgewählt sind, ist die Preserve Note 

Durations-Option nicht verfügbar.

In der folgenden Abbildung wird dargestellt, 
wie MIDI-Noten durch die verschiedenen 
Optionen unter „What to Quantize“ 
verschoben werden.

Vor dem Quantisieren und zwei Beispiele mit 
verschiedenen What To Quantize-Einstellungen
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Audio Clips. – wenn diese Option im What to 
Quantize-Popup-Menü ausgewählt ist, wird der 
Quantize-Befehl auf die Startpunkte (bzw. Sync-
Punkte, falls vorhanden) der Clips für ausgewählte 
Audioclips angewendet. MIDI-Clips sind davon 
nicht betroffen. In der Regel ist es sinnvoll, 
die Quantisierung nur auf in Slices unterteilte 
Audioclips oder Clipgruppen anzuwenden 
(etwa importierte REX-Dateien oder Clips, die mit 
dem Separate Clips at Transients-Befehl oder mit 
Beat Detective erstellt wurden). Die Quantisierung 
kann auf eine gemischte Selektion von MIDI-
Noten und Audioclips angewendet werden.

Elastic Audio Events. – wenn diese Option im 
What to Quantize-Popup-Menü ausgewählt ist, 
wird der Quantize-Befehl auf erfasste 
Signalspitzen in der Edit-Selektion auf Elastic 
Audio-fähigen Spuren angewendet. Die 
Quantisierung kann auf eine gemischte Selektion 
von MIDI-Noten und Elastic Audio-Events 
angewendet werden. Warp-Marker werden 
automatisch zusätzlich zu den Event-Markern 
erstellt, die sich am nächsten an dem 
Quantisierungsraster befinden. Bei der 
Quantisierung werden diese Warp-Marker dann 
verwendet, um die Quantisierung anzuwenden.

Quantize Grid
Quantize Grid-Popup-Menü. – bestimmt das 
Taktraster zum Ausrichten der MIDI-Noten, Elastic 
Audio-Events und Startpunkte der Audioclips. 
Als Auflösung für das Quantisierungsraster 
können alle Notenwerte von ganzen Noten bis 
zu Vierundsechzigstelnoten (1/64) (einschließlich 
punktierter Noten und Triolenwerte) ausgewählt 
werden. 

Tuplet. – wählen Sie die Tuplet-Option, 
um abweichende Notengruppierungen wie 
Quintolen (5 Noten, die den Zeitraum von 
4 Noten ausfüllen) zu quantisieren. Das 
Quantisierungsraster für n-Tolen wird aus den 
Einstellungen der Notendauer und des Tuplet-
Werts errechnet. Wenn beispielsweise eine 
Achtelnote 240 Ticks entspricht, ergibt 
ein Quintolen-Sechzehntel mit 5 in 4 ein 
Quantisierungsraster von 192 Ticks bzw. 
(240 Ticks/5) x 4.

Offset Grid By. – versetzt das Quantisierungsraster 
um die angegebene Anzahl von Ticks zeitlich nach 
vorne oder hinten. Verwenden Sie diese Option, 
um durch positive Werte einen treibenden Effekt 
oder durch negative Werte einen „relaxten“ Effekt 
zu erzielen.

Randomize. – wenn diese Option ausgewählt ist, 
werden MIDI-Noten, Elastic Audio-Events und 
Audioclips nach dem Zufallsprinzip (nach der 
Quantisierung) zeitlich vor- oder zurückversetzt. 
Wenn beispielsweise die Einstellung des 
Quantisierungsrasters auf Achtelnoten und 
die Randomize-Option auf 50 % gesetzt ist, 
werden Noten und Events um bis zu einer 
Zweiunddreißigstelnote vor oder hinter die 
Taktgrenze verschoben. Die Randomize-
Einstellung beeinflusst außerdem die Notendauer 
(sofern die Releases-Option ausgewählt ist).

Der Relative Grid-Modus hat keinerlei 
Auswirkung auf das Quantisierungsraster.

Um ausschließlich die Backbeats zu 
quantisieren, stellen Sie das 
Quantisierungsraster auf halbe Noten 
mit einem Offset von 960 Ticks ein.
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Weitere Grid Quantize-Optionen
Dazu gehören:

Swing. – wenn diese Option ausgewählt ist, 
wird jede Rastergrenze um einen festgelegten 
Prozentsatz (0–300) verschoben, um ein Swing-
Feeling zu erzeugen. Ein Swing-Wert von 0 % 
erzeugt keinerlei Swing-Effekt, während ein Wert 
von 100 % ein triolisches Feeling bewirkt. 
Einstellungen über 100 % verengen den Swing 
zusehends – bis zu einem Maximum von 300 %, 
bei dem jeder zweite Rasterpunkt zum jeweils 
nächsten verschoben wird.

Include Within. – wenn diese Option ausgewählt 
ist, werden nur die MIDI-Notenanfänge, MIDI-
Notenenden, Elastic Audio-Events und Audioclips 
quantisiert, die innerhalb des angegebenen 
Prozentbereichs des Quantisierungsrasters liegen. 
Verwenden Sie diese Option, um ausschließlich 
MIDI-Noten zu quantisieren, die nur geringfügig 
vom Quantisierungsraster abweichen. Noten, die 
weiter außerhalb des Taktschemas liegen, werden 
nicht quantisiert.

Die folgende Abbildung zeigt eine Einstellung, 
in der das Quantisierungsraster auf Viertelnoten 
und die Include Within-Option auf 50 % gesetzt 
ist. Ausschließlich MIDI-Notenanfänge und 
MIDI-Notenenden, die innerhalb des schattierten 
Bereichs liegen (der je einer Achtelnote vor und 
nach dem Taktraster entspricht), werden 
quantisiert.

Exclude Within. – wenn diese Option ausgewählt 
ist, werden die MIDI-Notenanfänge, MIDI-
Notenenden, Elastic Audio-Events und 
Audioclips, die innerhalb des angegebenen 
Prozentbereichs des Quantisierungsrasters liegen, 
nicht quantisiert. Verwenden Sie diese Option, 
um das Feeling von Events, die nah am 
Taktschema liegen, zu erhalten und solche zu 
korrigieren, die stark vom Quantisierungsraster 
abweichen.

Die folgende Abbildung zeigt eine Einstellung, in der 
das Quantisierungsraster auf Viertelnoten und die 
Exclude Within-Option auf 25 % gesetzt ist. 
In diesem Beispiel werden MIDI-Notenanfänge und 
MIDI-Notenenden, die innerhalb des schattierten 
Bereichs liegen (der je einer Sechzehntelnote vor und 
nach dem Taktraster entspricht), nicht quantisiert.

Strength. – wenn diese Option ausgewählt ist, 
werden MIDI-Noten, Elastic Audio-Events und 
Audioclips um einen bestimmten Prozentsatz zum 
Quantisierungsraster hin verschoben. Durch 
Eingabe von niedrigen Prozentwerten bleibt das 
ursprüngliche Feeling der Events erhalten. Höhere 
Prozentwerte bewirken, dass die jeweiligen Noten 
näher am Quantisierungsraster ausgerichtet 
werden.

100 % Swing, Achtelnoten-Raster

Jeder zweite Rasterpunkt 
durch Swing verschoben

0 % Swing
(480 Ticks)

100 % Swing
(640 Ticks)

Include Within-Option

Exclude Within-Option
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Grid Quantize-Beispiele
Die folgenden Beispiele verdeutlichen typische 
Einsatzmöglichkeiten für den Grid Quantize-Befehl.

Wenn Sie während der Quantisierung Material als 
Loop wiedergeben wollen, können Sie die 
Einstellung „Options > Link Timeline and Edit 
Selection“ deaktivieren. Damit wird sichergestellt, 
dass sich der Wiedergabebereich nicht ändert, 
wenn ausgewählte Noten durch eine Quantisierung 
verschoben werden oder eine Quantisierung 
rückgängig gemacht wird.

Starre Quantisierung

So quantisieren Sie auf ein starres 
Sechzehntelnoten-Feeling:

1 Wählen Sie den Bereich der MIDI-Noten, 
Elastic Audio-Events oder Audioclips aus, 
der quantisiert werden soll.

2 Wählen Sie Event > Event Operations > 

Quantize.

3 Wählen Sie unter „What to Quantize“ die Note 
On-Option für die Quantisierung der MIDI-
Noten. Um auch die Dauer von MIDI-Noten zu 
quantisieren, wählen Sie die Note Off-Option. 
Wenn Sie Audiomaterial quantisieren, wählen 
Sie die Option Audio Clips oder Elastic Audio 

Events aus dem Popup-Menü.

4 Wählen Sie im Quantize Grid-Popup-Menü 
Sechzehntelnoten (1/16). Vergewissern Sie 
sich, dass die Optionen für „Tuplet“, „Offset 
Grid By“ und „Swing“ nicht ausgewählt sind.

5 Stellen Sie sicher, dass die verbleibenden 
Quantisierungsoptionen deaktiviert sind.

6 Klicken Sie auf Anwenden.

Quantisieren und gleichzeitiges 
Beibehalten des ursprünglichen 
Feelings
Um das ursprüngliche Feeling Ihrer aufgenommenen 
MIDI- und Audiospuren zu erhalten, können Sie 
auch weniger streng quantisieren.

So behalten Sie bei der Quantisierung das 
ursprüngliche Feeling bei:

1 Wählen Sie den Bereich der MIDI-Noten, 
Elastic Audio-Events oder Audioclips aus, 
der quantisiert werden soll.

2 Wählen Sie Event > Event Operations > 

Quantize.

3 Wählen Sie unter „What to Quantize“ die Note 

On-Option für die Quantisierung der MIDI-
Noten. Um auch die Dauer von MIDI-Noten zu 
quantisieren, wählen Sie die Note Off-Option. 
Wenn Sie Audiomaterial quantisieren, wählen 
Sie die Option Audio Clips oder Elastic Audio 

Events aus dem Popup-Menü.

4 Wählen Sie im Quantize Grid-Popup-Menü den 
gewünschten Notenwert. 

5 Stellen Sie sicher, dass die anderen Optionen für 
„Tuplet“, „Offset Grid By“ und „Swing“ nicht 
aktiviert sind.

6 Wählen Sie die Exlude Within-Option und stellen 
Sie einen Wert zwischen 10 und 15 % ein.

7 Wählen Sie die Strength-Option und stellen Sie 
einen Wert zwischen 70 und 80 % ein.

8 Stellen Sie sicher, dass die verbleibenden 
Quantisierungsoptionen deaktiviert sind.

9 Klicken Sie auf Anwenden.

10 Hören Sie sich die Änderungen an. Wenn 
der gewünschte Effekt nicht erreicht wurde, 
machen Sie die Änderungen rückgängig und 
experimentieren Sie mit verschiedenen Werten 
für die Optionen Exclude Within und Strength.

Nach der Quantisierung können Sie mit 
„Restore Performance“ die ursprüngliche 
Version wiederherstellen (siehe „Restore 
Performance“ auf Seite 950).
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Quantisieren mit Swing
Wenn Sie mit MIDI Hi-Hats, Bass-Material oder 
Audio-Entsprechungen arbeiten, haben Sie die 
Möglichkeit, der Spur etwas mehr Swing-Feeling 
zu verleihen.

So quantisieren Sie mit einem Achtelnoten-Swing-
Feeling:

1 Wählen Sie den Bereich der MIDI-Noten, 
Elastic Audio-Events oder Audioclips aus, 
der quantisiert werden soll.

2 Wählen Sie Event > Event Operations > 

Quantize.

3 Wählen Sie unter „What to Quantize“ die Note 

On-Option für die Quantisierung der MIDI-
Noten. Um auch die Dauer von MIDI-Noten zu 
quantisieren, wählen Sie die Note Off-Option. 
Wenn Sie Audiomaterial quantisieren, wählen 
Sie die Option Audio Clips oder Elastic Audio 

Events aus dem Popup-Menü.

4 Wählen Sie im Quantize Grid-Popup-Menü 
Achtelnoten (1/8). 

5 Wählen Sie die Swing-Option und stellen Sie 
den gewünschten Prozentwert ein:

• 12 % für einen leichten Swing

• 24 % für einen etwas strafferen, swingenden 
Groove

• 50 bis 75 % für ein echtes triolisches Swing-
Feeling

6 Stellen Sie sicher, dass die Optionen „Tuplet“, 
„Offset Grid By“ und „Randomize“ nicht 
ausgewählt sind. 

7 Klicken Sie auf Anwenden.

8 Hören Sie sich die Änderungen an. Wenn 
der gewünschte Effekt nicht erzielt wurde, 
machen Sie die Änderungen rückgängig und 
experimentieren Sie mit einem anderen Wert für 
die Swing-Option.

Quantisieren mit Randomize
Wenn quantisierte Events zu mechanisch oder 
taktgenau klingen, können Sie diese mithilfe der 
Randomize-Option im Quantize-Fenster 
natürlicher klingen lassen.

So geben Sie Events ein etwas „menschlicheres“, 
rhythmisches Feeling:

1 Wählen Sie den Bereich der MIDI-Noten, 
Elastic Audio-Events oder Audioclips aus, 
der quantisiert werden soll.

2 Wählen Sie Event > Event Operations > 

Quantize.

3 Wählen Sie unter „What to Quantize“ die Note 

On-Option für die Quantisierung der MIDI-
Noten. Um auch die Dauer von MIDI-Noten zu 
quantisieren, wählen Sie die Note Off-Option. 
Wenn Sie Audiomaterial quantisieren, wählen 
Sie die Option Audio Clips oder Elastic Audio 

Events aus dem Popup-Menü.

4 Wählen Sie im Quantize Grid-Popup-Menü den 
gewünschten Notenwert. 

5 Wählen Sie die Randomize-Option und geben 
Sie einen Wert von 5 % ein.

6 Klicken Sie auf Anwenden.

7 Hören Sie sich die Änderungen an. Wenn der 
gewünschte Effekt nicht erzielt wurde, machen 
Sie die Änderungen rückgängig und 
experimentieren Sie mit einem anderen Wert für 
die Randomize-Option.
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Experimentieren mit Grid 
Quantize
Bei Verwendung des Quantize-Befehls müssen 
Sie möglicherweise mit einigen Steuerelementen 
etwas experimentieren, um die gewünschten 
Ergebnisse zu erzielen. Probieren Sie verschiedene 
Werte für die Optionen Include Within bzw. 
Exclude Within und Strength. Mit diesen 
Steuerelementen wird festgelegt, welche Noten 
beeinflusst werden und wie umfangreich die 
vorgenommenen Änderungen sind. Außerdem 
kann die Randomize-Option verwendet werden, 
die einer Quantisierung einen in Prozent 
ausgedrückten Anteil an Zufälligkeit verleiht und 
eine Spur weniger „mechanisch“ wirken lässt.

Groove Quantize
Im Quantize-Fenster können Sie „Groove 
Quantize“ anwenden, wenn im Quantize Grid-
Popup-Menü eine Groove-Vorlage ausgewählt ist. 
Mit „Groove Quantize“ werden Position und 
Dauer von MIDI-Noten, Elastic Audio-Events und 
Audioclips an eine Groove-Vorlage statt an ein 
strenges Quantisierungsraster angepasst. Mithilfe 
einer Groove-Vorlage kann ein bestimmtes 
rhythmisches Feeling eines Musikstücks oder 
einer MIDI-Performance übernommen und auf 
eine andere MIDI-Sequenz oder Audio-Selektion 
angewendet werden. DigiGroove-Vorlagen 
können unter Verwendung von Beat Detective 
erstellt werden.

Groove-Vorlagen
Groove-Vorlagen (etwa DigiGroove-Vorlagen) 
sind „Quantisierungs-Maps“, die aus der 
tatsächlichen Darbietung (Performance) eines 
Musikstücks abgeleitet werden. Der Rhythmus des 
Stücks wird analysiert und als Groove-Vorlage 
gespeichert. Mit Groove-Vorlagen kann das 
Feeling einer Performance auf MIDI-Noten 
(Timing, Dauer und Geschwindigkeit), Elastic 
Audio-Events und Audioclips übertragen werden.

DigiGroove-Vorlagen können unter Verwendung 
von Beat Detective generiert werden. Beat 
Detective analysiert eine Audioselektion und stellt 
anhand eines festgelegten Schwellenwerts die 
Signalspitzen fest. Das Programm weist die 
rhythmischen Beziehungen einer Vorlage mit 
einer Auflösung von 960 Impulsen pro Viertelnote 
(ppq) zu. Mit Beat Detective kann auch eine MIDI-
Selektion für Notenanfänge und Velocity-Werte 
zur Erstellung von Groove-Vorlagen analysiert 
werden. Diese Vorlage kann dann mit Groove 
Quantize und Beat Detective verwendet werden.

Quantize-Optionen mit ausgewählter Groove-Vorlage
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DigiGroove-Vorlagen sind außerdem bei Avid und 
anderen Herstellern erhältlich. 

Groove Quantize-Einstellungen
Quantize Grid-Popup-Menü. – legt fest, welche 
Groove-Vorlage für die Quantisierung zu 
verwenden ist. Alle im Groove-Ordner abgelegten 
Vorlagendateien sind im Quantize Grid-Popup-
Menü verfügbar. 

Grooves-Dateien werden im Unterordner 
„Grooves“ des Ordners „Root Settings“ 
gespeichert. Sie können den Speicherort des 
Ordners „Root Settings“ unter „Operation 
Preferences“ ändern (siehe „User Library-
Abschnitt“ auf Seite 110).

Wenn Sie im Groove-Ordner die Groove-Vorlagen 
in Unterordnern organisieren, werden diese als 
Untermenüs auch im Popup-Menü angezeigt. 
Nach Auswahl der Groove-Vorlage werden im 
Popup-Menü spezifische Informationen zu Taktart 
und Dauer (in Takten) angezeigt.

Show Comments. – das Comments-Feld enthält 
sämtliche mit der Groove-Vorlage aus Beat 
Detective gespeicherten Anmerkungen. 
Das Comments-Feld kann nicht direkt auf der 
Quantize-Seite, sondern ausschließlich beim 
Speichern einer Groove-Vorlage aus der Groove 
Quantize-Seite bearbeitet werden.

Pre-Quantize. – führt vor der Groove-Quantisierung 
ein starkes Quantisieren der selektierten MIDI-Noten 
gemäß den Einstellungen des Groove Quantize-
Befehls aus. 

Groove Quantize-Optionen

Timing. – wendet die Groove-Quantisierung auf die 
ausgewählten MIDI-Noten, Elastic Audio-Events 
oder Audioclips an. Mithilfe des Schiebereglers 
können Sie den Quantisierungsgrad der Selektion 
ändern. Wenn der Schieberegler auf 0 % gestellt ist, 
wird das Timing nicht geändert. Wenn der 
Schieberegler auf 100 % gestellt ist, werden die 
Noten an die Position in der Vorlage verschoben. 
Wenn der Schieberegler auf 200 % gestellt ist, 
werden Events an eine Position verschoben, die der 
zweifachen Differenz zwischen ursprünglicher 
Eventposition und der Position des Vorlagen-
Events entspricht. 

Beispiel: Ein Event in Takt 1|1|060 
(eine Sechzehntelnote) entspricht dem Vorlagen-
Event an Position 1|1|073. Wenn der Schieberegler 
auf 100 % gestellt wird, wird das Event an Position 
1|1|073 verschoben. Wenn der Schieberegler auf 
200 % gestellt wird, wird die Note an Position 
1|1|086 verschoben.

Die Standardeinstellung für den Timing-
Schieberegler ist 100 %.

Weitere Informationen zu Beat Detective und 
zur Erstellung von Groove-Vorlagen 
erhalten Sie in Kapitel 30: „Beat Detective“.

Pro Tools unterstützt Feel Injector-Vorlagen 
von Numerical Sound (960 PPQ); DNA 
Groove-Vorlagen (192 PPQ) werden 
allerdings nicht unterstützt.
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Dauer. – beeinflusst die Dauer der selektierten 
MIDI-Noten. Die Duration-Option gilt nicht für 
Audio-Selektionen. Bei einer Einstellung von 
100 % wird die Dauer dahingehend geändert, 
dass sie genau der aktuellen Groove-Vorlage 
entspricht. Bei 200 % ändert sich Dauer abhängig 
vom Verhältnis zwischen ursprünglicher Dauer 
der selektierten Noten und Dauer in der Vorlage. 

Die Standardeinstellung für den Duration-
Schieberegler ist 100 %.

Velocity. – beeinflusst die Velocity-Werte der 
selektierten MIDI-Noten. Die Velocity-Option gilt 
nicht für Audio-Selektionen. Wenn der Regler auf 
0 % gestellt ist, bleiben die ausgewählten 
Velocity-Werte unverändert; bei einer Einstellung 
von 100 % werden alle Werte dahingehend 
geändert, dass sie genau den Velocity-Werten der 
Vorlage entsprechen. Eine Einstellung von 200 % 
führt üblicherweise zu einer übertriebenen 
Velocity, mit dem Effekt, dass laute Noten noch 
lauter und leisere Noten noch leiser werden. 

Wenn etwa zwei nebeneinanderliegende Noten 
denselben Velocity-Wert (80) aufweisen und 
die beiden entsprechenden Velocity-Werte der 
Vorlage 70 bzw. 90 lauten, so werden bei der 
Einstellung von 200 % die Velocity-Werte in 
60 bzw. 100 geändert.

Die Standardeinstellung für den Velocity-
Schieberegler ist 100 %.

Aufrufen von 
Schiebereglereinstellungen

So speichern Sie eine Groove-Vorlage mit 
den aktuellen Schiebereglereinstellungen 
der Optionen:

1 Wählen Sie im Quantize-Fenster die Option 
Recall with Template, wenn Sie alle Groove 
Quantize-Optionen auf die zuletzt 
gespeicherten Einstellungen der aktuellen 
Vorlage zurücksetzen möchten.

2 Klicken Sie auf die Save-Schaltfläche.

3 Geben Sie Ihre Anmerkungen bei Bedarf in die 
Vorlage ein und speichern Sie sie.

4 Sie haben folgende Möglichkeiten:

• Klicken Sie auf Save, um die Groove-Vorlage 
mit den aktuellen Schiebereglereinstellungen 
der Optionen zu speichern.

• Klicken Sie auf Save As, um eine Kopie der 
Groove-Vorlage mit den aktuellen 
Schiebereglereinstellungen der Optionen zu 
speichern. Geben Sie anschließend im Save-
Dialogfeld einen Namen für die Kopie ein und 
klicken Sie auf Save.

Die Schiebereglereinstellungen gehen unter 
Umständen verloren, wenn Sie einen der 
folgenden Vorgänge ausführen, ohne die 
Einstellungen zuvor zu speichern:

• Auswählen eines anderen Event Operations-
Felds

• Schließen des Event Operations-Fensters

• Wechseln zu einer anderen Groove-Vorlage

Mit Beat Detective ist es nicht möglich, 
Informationen zur Notendauer aus einem 
Musikstück zu extrahieren. Mit Beat 
Detective erstellte DigiGroove-Vorlagen 
enthalten einen festen Wert für die Dauer, 
der 50 % der ausgewählten 
Vorlagenauflösung entspricht (siehe 
„Definieren einer Beat Detective-
Selektion“ auf Seite 668).
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Anwenden von Groove-Vorlagen
Groove-Vorlagen können beliebig lang sein und 
auf eine beliebige Anzahl von Takten angewendet 
werden. In der Regel werden Groove-Vorlagen auf 
Selektionen mit derselben Länge und Taktart 
angewendet. Sie können jedoch auch auf 
unterschiedliche Taktarten angewendet werden; 
so kann etwa eine Groove-Vorlage im 6/8-Takt 
durchaus auch für eine Selektion im 4/4-Takt 
übernommen werden. Darüber hinaus ist es auch 
nicht notwendig, beim Selektieren eines Takts mit 
dem ersten Schlag zu beginnen.

So wenden Sie Groove Quantize an:

1 Wählen Sie mit dem Grabber- oder Selector-
Tool die MIDI-Noten, Elastic Audio-Events 
oder Audioclips aus, auf die Sie die Groove-
Quantisierung anwenden möchten.

2 Wählen Sie Event > Event Operations > 

Quantize.

3 Wählen Sie im Grid Quantize-Popup-Menü 
eine Groove-Vorlage.

4 Aktivieren Sie die Optionen Timing, Duration 
und Velocity und stellen Sie die dazugehörigen 
Schieberegler auf die gewünschten Positionen.

5 Aktivieren Sie bei Bedarf auch Pre-Quantize.

6 Klicken Sie auf die Apply-Schaltfläche. 

DigiGroove-Vorlage (vom dargestellten Audio abgeleitet), auf eine Reihe von Sechzehntelnoten mit Timing- und 
Velocity-Einstellung von 100 % angewendet
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Zuweisen von Groove-Vorlagen
In Pro Tools werden Groove-Vorlagen relativ zum 
Anfang des Songs angewendet. Eine zweitaktige 
Groove-Vorlage wird etwa zu Beginn jedes 
ungeraden Takts der Session (Takt 1, 3, 5, 7 usw.) 
wiederholt.

Vorlagenzuweisung für gleiche Taktarten und 
ungerade Takte

Wenn Sie eine zweitaktige Groove-Vorlage auf 
eine Selektion mit einem Takt und derselben 
Taktart anwenden, wird nur der erste Takt der 
Vorlage verwendet. Wenn die Selektion keine 
Taktgrenzen (etwa 1|2|000 bis 2|1|000) umfasst, 
werden nur die ausgewählten Noten geändert.

Vorlagenzuweisung für gleiche Taktarten und 
gerade Takte

Wenn eine Selektion mit einem geraden Takt 
beginnt, wird nur der entsprechende Teil der 
Groove-Vorlage verwendet. Wenn die Selektion 
zwei Takte lang ist und mit einem geraden Takt 
beginnt, wird Takt 2 der Vorlage vor Takt 1 
angewendet. 

Vorlagenzuweisung für ungleiche Taktarten

Wenn Groove-Vorlagen und Spur-Selektionen 
ungleiche Taktarten aufweisen, wird die Vorlage 
wiederholt oder abgeschnitten, um sie der 
Selektion anzupassen.

Wenn die Groove-Vorlage etwa weniger Schläge 
als die Selektion enthält (angenommen, eine 
eintaktige Vorlage in 6/8 wurde auf eine eintaktige 
4/4-Selektion angewendet), wird die Vorlage 
wiederholt, um fehlende Schläge auszugleichen.

Wiederholungsmuster einer zweitaktigen Groove-
Vorlage

Anwenden einer zweitaktigen Groove-Vorlage auf 
eine eintaktige Selektion und eine ungerade Taktzahl

Zweitaktige
Groove-
Vorlage

Zweitaktige
Groove-
Vorlage

Zweitaktige
Groove-
Vorlage

Zweitaktige
Groove-
Vorlage

4/4-Takt 1 4/4-Takt 2 (nicht verwendet)

Eintaktige 4/4-Selektion

Anwenden einer zweitaktigen Groove-Vorlage auf 
eine eintaktige Selektion und eine gerade Taktzahl

Anwenden einer eintaktigen 6/8-Groove-Vorlage auf 
eine eintaktige 4/4-Selektion

4/4-Takt 1 (nicht verwendet) 4/4-Takt 2

Eintaktige 4/4-Selektion

6/8-Takt 1

Eintaktige 4/4-Selektion

Wiederholter 6/8-Takt 1
(Schlag 3–6 
nicht verwendet)
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Wenn die Groove-Vorlage mehr Schläge als die 
Selektion auf einer Spur enthält (angenommen, 
eine eintaktige 6/4-Vorlage wurde auf eine 
eintaktige 4/4-Selektion angewendet), wird nur 
die benötigte Anzahl von Schlägen verwendet.

Gemischte Taktarten

Bei einer Selektion mit gemischten Taktarten wird 
die Vorlage am ersten Takt ausgerichtet. Beispiel: 
Eine eintaktige Groove-Vorlage im 4/4-Takt wird 
auf eine eintaktige Selektion angewendet, die 
aufeinanderfolgend einen 4/4-, einen 7/16- und 
einen 5/8-Takt umfasst. In diesem Fall wird der 
erste Schlag der Groove-Vorlage an den jeweils 
ersten Schlägen der Takte ausgerichtet und nur die 
benötigte Anzahl von Schlägen wird übernommen.

Quantisieren von Elastic 
Audio
Mit Pro Tools können Sie die Quantisierung auf 
Elastic Audio-Events und MIDI-Noten anwenden. 
Die Quantisierung kann auf Event- und Warp-
Marker angewendet werden, die sich auf Elastic 
Audio-fähigen Spuren am nächsten am 
Quantisierungsraster befinden, unabhängig davon, 
ob sie tickbasiert oder samplebasiert sind. Bei der 
Quantisierung werden Event-Marker, die sich am 
nächsten am Quantisierungsraster befinden, zu 
Warp-Markern heraufgestuft, und alle Warp-
Marker, die sich am nächsten am 
Quantisierungsraster befinden, werden basierend 
auf den Quantize-Einstellungen quantisiert.

Die Quantisierung kann auch auf Startzeiten (oder 
Sync-Punkte) von Clips auf allen Audiospuren 
angewendet werden, unabhängig davon, ob sie 
Elastic Audio-fähig, Sample- oder Tick-basiert 
sind. Auf diese Weise können Sie Audioclips 
schnell quantisieren, ohne TCE anzuwenden. Dies 
ist insbesondere hilfreich, wenn mit „One-Shot-
Clips“ (Clips mit einem einzigen Event) gearbeitet 
wird, beispielsweise in Slices unterteilte 
Audioclips oder Clipgruppen.

Anwenden einer eintaktigen 6/4-Groove-Vorlage auf 
eine eintaktige 4/4-Selektion

Anwenden einer eintaktigen 4/4-Groove-Vorlage auf 
eine dreitaktige Selektion mit verschiedenen Taktarten

6/4-Takt 1

Eintaktige 4/4-Selektion

(Schlag 3–6 
nicht 
verwendet)

Dreitaktige Selektion 

4/4-Takt 1

4/4-Takt 1

4/4-Takt 1

(nicht verwendet)

unterschiedlicher Taktarten

Sie können das Groove-Vorlagenraster durch 
Hinzufügen einer neuen Taktartmarkierung 
zurücksetzen (dabei kann es sich auch um 
dieselbe Taktart handeln). Die Groove-
Vorlage wird an der Taktartmarkierung neu 
gestartet, unabhängig davon, um wie viele 
Takte es sich handelt oder ob die Taktart 
geändert wurde.

Verwenden Sie „Restore Performance“, 
um die Quantisierung von Audiodaten und 
MIDI rückgängig zu machen. Siehe 
„Restore Performance“ auf Seite 950.
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So quantisieren Sie Elastic Audio-Events:

1 Wählen Sie das Audiomaterial aus, das Sie 
auf Elastic Audio-fähigen Spuren quantisieren 
möchten. (Audiodaten, die sich nicht auf Elastic 
Audio-fähigen Spuren befinden, werden 
nicht quantisiert.)

2 Wählen Sie Events > Event Operations > 

Quantize. 

3 Wählen Sie im Quantize-Fenster die Option 
Elastic Audio Events aus dem What to 
Quantize-Popup-Menü.

4 Legen Sie die Einstellungen für Quantize Grid 
und Optionen fest.

5 Klicken Sie auf Anwenden.

Die Warp- und Event-Marker, die sich am 
nächsten am Quantisierungsraster befinden, 
werden entsprechend quantisiert. TCE wird 
zwischen diesen Markern angewendet. Alle 
anderen Marker behalten ihre Position relativ 
zum Quantisierungsraster.

Quantisieren von Audioclips
Mit Pro Tools können Sie Startpunkte (bzw. Sync-
Punkte) von Audioclips mithilfe der Quantize-
Operation quantisieren. Startpunkte (bzw. Sync-
Punkte) von Audioclips werden auf den 
nächstgelegenen Quantisierungsraster-
Wert quantisiert. 

So quantisieren Sie Audioclips:

1 Wählen Sie die Audioclips, die Sie 
quantisieren möchten. 

2 Wählen Sie Events > Event Operations > 

Quantize. 

3 Wählen Sie im Quantize-Fenster die Option 
Audio Clips aus dem What to Quantize-
Popup-Menü.

4 Legen Sie die Einstellungen für Quantize Grid 
und Optionen fest.

Vor der Quantisierung: Elastic Audio-Events in der 
Warp-Darstellung

Nach der Quantisierung: Quantisierte Elastic Audio-
Events in der Warp-Darstellung

Bei der Quantisierung von Clipgruppen wird 
nur die Position des Startpunkts (bzw. Sync-
Punkts) angepasst. Um die zugrunde 
liegenden, in Slices unterteilten Clips in einer 
Clipgruppe zu quantisieren, müssen Sie sie 
zuerst auflösen, dann die Quantisierung 
durchführen und schließlich die Clipgruppe 
wiederherstellen. Weitere Informationen zu 
Clipgruppen finden Sie unter „Clipgruppen“ 
auf Seite 877.
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5 Klicken Sie auf Anwenden.

Die Startzeiten (oder Sync-Punkte, falls 
vorhanden) von Clips werden entsprechend den 
Quantize-Einstellungen quantisiert.

Quantisieren von gemischten 
Selektionen
Sie können die Quantisierung gleichzeitig sowohl 
auf MIDI-Noten als auch auf Audioclips oder 
sowohl auf MIDI-Noten und Elastic Audio-
Events anwenden. Es ist jedoch nicht möglich, 
die Quantisierung gleichzeitig sowohl auf 
Audioclips (nicht Elastic Audio) als auch auf 
Elastic Audio-Events anzuwenden.

Restore Performance
Mit dem Restore Performance-Befehl können 
Sie alle selektierten MIDI-Noten im Event 
Operations-Fenster wieder in den ursprünglichen 
Zustand (bei ihrer ersten Aufnahme oder manuellen 
Einfügung) versetzen, selbst wenn die Session bereits 
gespeichert oder die Undo-Reihe bereits gelöscht 
wurde. Restore Performance kann auch auf 
quantisierte Elastic Audio-Events oder quantisierte 
Audioclips angewendet werden.

Die folgenden MIDI-Noten-, Elastic Audio-Event- 
und Audioclip-Attribute können wiederhergestellt 
werden.

Timing (Quantization). – stellt die ursprünglichen 
Startzeiten der ausgewählten Noten, Audioclips 
und Elastic Audio-Events wieder her. Falls die 
Duration-Option nicht aktiviert ist, bewirkt dies 
bei MIDI-Noten eine Änderung der Dauer 
ausgewählter Noten. 

Dauer. – stellt die ursprüngliche Dauer der 
ausgewählten Noten wieder her. Wenn die Timing 

(Quantization)-Option nicht aktiviert ist, wird 
die Startzeit der ausgewählten Noten nicht 
wiederhergestellt und die Änderung wirkt sich 
ausschließlich auf die Endzeit der Note aus. 
Die Duration-Option hat keine Auswirkung 
auf Audiodaten.

Audioclips vor und nach der Quantisierung

Event Operations-Fenster, Restore Performance

Der Restore Performance-Befehl kann 
rückgängig gemacht werden.
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Velocity. – stellt die ursprünglichen Velocity-
Werte der ausgewählten Noten wieder her. 
Velocity hat keine Auswirkung auf Audiodaten.

Pitch. – stellt die ursprünglichen Tonhöhen der 
ausgewählten Noten und die in der Tonhöhe 
korrigierten Elastic Audio-Clips wieder her.

So können Sie die ursprüngliche Zeit, Dauer, 
Geschwindigkeit oder Tonhöhe für ausgewählte 
MIDI-Noten, Audioclips oder Elastic Audio-Events 
wiederherstellen:

1 Wählen Sie die MIDI-Noten, Audioclips oder 
Elastic Audio-Events aus, die Sie 
wiederherstellen möchten.

2 Wählen Sie Event > Event Operations > 
Restore Performance.

3 Wählen Sie aus, welche Eigenschaften 
wiederhergestellt werden sollen.

4 Klicken Sie auf Anwenden.

Durch diesen Befehl werden alle durch die Befehle 
Quantize, Change Duration (nur MIDI), Change 
Velocity (nur MIDI) oder Transpose 
vorgenommenen Änderungen rückgängig 
gemacht und der ursprüngliche Zustand 
wiederhergestellt. Darüber hinaus werden auch 
alle mit „Input Quantize“ aufgenommenen MIDI-
Noten wiederhergestellt (siehe „Input Quantize“ 
auf Seite 961).

Input Quantize aufheben
Der Restore Performance-Befehl kann auch dazu 
verwendet werden, um die Quantisierung bei der 
Eingabe von MIDI-Noten rückgängig zu machen. 
Wenn Sie etwa ein Musikstück mit aktivierter 
Input Quantize-Option aufgenommen haben, 
können Sie den ursprünglich eingespielten 
Klang des Musikstücks wiederherstellen.

Flatten Performance
Der Flatten Performance-Befehl im Event 
Operations-Fenster übernimmt den aktuellen 
Zustand der selektierten Noten und erstellt somit 
einen neuen „ursprünglichen“ Zustand, der bei 
Verwendung des Restore Performance-Befehls 
wiederhergestellt wird.

Mit dem Restore Performance-Befehl lassen 
sich ausgeschnittene, kopierte, eingefügte 
oder anderweitig manuell verschobene 
MIDI-Noten, Audioclips oder Elastic Audio-
Events nicht wiederherstellen.

Sie können mit diesem Befehl das Trimmen 
der Notenlänge nicht wieder rückgängig 
machen. Durch das Trimmen einer Note wird 
eine grundlegende Änderung des Timings 
vorgenommen, die in Pro Tools manuell 
rückgängig gemacht werden muss.

Weitere Informationen zu „Input 
Quantize“ finden Sie unter „Input 
Quantize“ auf Seite 961.

Event Operations-Fenster, Flatten Performance

Der Flatten Performance-Befehl kann 
rückgängig gemacht werden.
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So konsolidieren Sie ein Musikstück:

1 Selektieren Sie mit dem Grabber- oder Selector-
Tool die MIDI-Noten, deren ursprüngliche 
Werte Sie konsolidieren möchten.

2 Wählen Sie Event > Event Operations > Flatten 
Performance, um die Flatten Performance-Seite 
zu öffnen.

3 Wählen Sie die Konsolidierungseigenschaften 
der Noten. Eine Beschreibung dieser 
Eigenschaften finden Sie in „Restore 
Performance“ auf Seite 950.

4 Klicken Sie auf Anwenden. 

Velocity ändern
Mit dem Change Velocity-Befehl im Event 
Operations-Fenster können die Note On- und Note 
Off-Velocity-Werte (also Attack- und Release-
Werte) ausgewählter MIDI-Noten automatisch 
angepasst werden. Verwenden Sie den Befehl, um 
Noten lauter oder weicher klingen zu lassen bzw. 
Crescendi oder Decrescendi zu erzeugen.

Velocity-Werte können auch manuell mit dem 
Pencil- oder Grabber-Tool bearbeitet werden 
(siehe „Manuelles Editieren von MIDI-Noten“ auf 
Seite 700).

Fades mit Velocity-Werten
So erreichen Sie einen weichen Übergang bei 
Fades mit Velocity-Werten:

1 Selektieren Sie den zu bearbeitenden MIDI-
Notenbereich.

2 Wählen Sie Event > Event Operations > 
Change Velocity.

3 Wählen Sie die Change Smoothly-Option mit 
dem Wertebereich von 127 bis 0.

4 Klicken Sie auf Anwenden.

Erhalten bestehender 
Relationen zwischen Velocity-
Werten
Um die bestehenden Relationen zwischen den 
einzelnen Velocity-Werten zumindest teilweise zu 
erhalten, gleichzeitig jedoch Velocity-Fades zu 
erzeugen, verwenden Sie die Change Smoothly by 
Percentage-Option. Die folgende Abbildung 
verdeutlicht die Unterschiede zwischen den beiden 
Change Smoothly-Optionen.

Skalieren von Velocity-Werten
Es kommt häufig vor, dass die Velocity-Werte 
bereits die gewünschte Relation zueinander 
aufweisen, die Noten insgesamt aber entweder zu 
leise oder zu laut sind. Verwenden Sie in diesen 
Fällen die Scale By-Option.

Mithilfe von MIDI-Echtzeit-Eigenschaften 
können Sie die Velocity auch in Echtzeit nicht 
destruktiv ändern. Siehe „MIDI-Echtzeit-
Eigenschaften“ auf Seite 726.

Ursprüngliche Velocity-Werte

Nach „Change Smoothly by Percentage“, Velocity von 
100 % auf 20 %

Nach „Change Smoothly“, Velocity von 100 auf 10
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So erhöhen Sie Velocity-Werte beispielsweise 
um 20 %:

1 Selektieren Sie den zu bearbeitenden MIDI-
Notenbereich.

2 Wählen Sie Event > Event Operations > 

Change Velocity.

3 Wählen Sie die Scale By-Option und geben Sie 
einen Prozentwert von 120 % ein.

4 Klicken Sie auf Anwenden.

Change Velocity-Einstellungen

Note On. – wendet die Change Velocity-Option 
auf die MIDI-Notenanfänge an.

Note Off. – wendet die Change Velocity-Option 
auf die MIDI-Notenenden an.

Set All To. – legt alle Velocity-Werte auf den 
angegebenen Wert fest (1–127).

Add. – erhöht alle vorhandenen Velocity-Werte 
um den angegebenen Wert (1–127).

Subtract. – verringert alle vorhandenen Velocity-
Werte um den angegebenen Wert (1–127).

Scale By. – verändert alle Velocity-Werte um den 
angegebenen Prozentwert (1–400 %).

Change Smoothly. – bewirkt einen weichen 
Übergang zwischen unterschiedlichen Velocity-
Werten innerhalb eines bestimmten Zeitraums.

Change Smoothly by Percentage. – bewirkt einen 
weichen, prozentual definierten Übergang 
zwischen unterschiedlichen Velocity-Werten 
innerhalb eines bestimmten Zeitraums. 

Event Operations-Fenster, Change Velocity

Die Velocity-Werte beeinflussen in der 
Regel die Lautstärke von MIDI-Noten. 
In Abhängigkeit davon, wie Velocity-Werte 
MIDI-Instrumenten zugewiesen sind, können 
Velocity-Werte auch andere Aspekte eines 
Instrumentenklangs beeinflussen, wie etwa 
die Filtergrenzfrequenzen, Hüllkurven und 
Modulationen.

Die Einstellungen im Change Velocity-
Fenster werden mit jeder Session 
abgespeichert. Um bevorzugte 
Einstellungen für zukünftige Sessions als 
Standardeinstellungen zu verwenden, 
speichern Sie sie als Bestandteil einer 
Session-Vorlage (siehe „Session-Vorlagen“ 
auf Seite 169).

Obwohl Optionen zur Einstellung von Note 
On- und Note Off-Velocity-Werten (also 
Attack- und Release-Werten) vorhanden sind, 
werden Informationen zur Release-Velocity 
von den meisten MIDI-Geräten nicht erkannt. 
Sehen Sie in der Dokumentation zu Ihrem 
Gerät nach, ob dieses Release-Velocity-
Werte verarbeiten kann.
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Der Kurvenverlauf für diesen Übergang kann 
eingegeben werden (+/– 99). Der Wert legt fest, 
wie graduell der Übergang erfolgt.

Limit To. – wenn diese Option ausgewählt ist, wird 
der Wertebereich für den Change Velocity-Befehl 
auf einen minimalen und maximalen Velocity-
Wert beschränkt, nachdem die ausgewählte 
Change Velocity-Option (oder eine Randomize-
Option) angewendet wurde.

Randomize. – wenn diese Option ausgewählt ist, 
weichen die Werte von der Change Velocity-
Einstellung um einen bestimmten Prozentwert 
nach dem Zufallsprinzip ab, nachdem die 
ausgewählte Change Velocity-Option angewendet 
wurde. Wenn beispielsweise die Set All To-Option 
aktiviert und auf einen Wert von 64 festgelegt ist, 
und die Randomize-Option aktiviert und auf einen 
Wert von 50 % festgelegt ist, betragen die 
resultierenden Velocity-Werte zwischen 48 und 80 
(+/– 25 % des Velocity-Werts). 

So wird die Randomize-Option auf ausgewählte 
Velocity-Werte ohne andere Change Velocity-
Optionen angewendet:

1 Aktivieren Sie die Scale By-Option und legen 
Sie sie auf 100 % fest.

2 Aktivieren Sie die Randomize-Option und 
legen Sie den gewünschten Wert für die Option 
fest.

3 Klicken Sie auf Anwenden.

Velocity-Bereiche
MIDI-Noten können Velocity-Werte im Bereich 
von 1 bis 127 aufweisen. Mit dem Change 
Velocity-Befehl ist es nicht möglich, Velocity-
Werte zu erzeugen, die außerhalb dieses Bereichs 
liegen. Der Wert 1 steht immer für die niedrigste 

Velocity, der Wert 127 immer für die höchste. Es 
kann also sein, dass Sie an einen Punkt kommen, 
an dem der Change Velocity-Befehl keine 
Auswirkung mehr auf eine bestimmte Note hat.

Wenn eine Note mit einem Velocity-Wert von 64 
um 200 % hochgestuft wird, beträgt der neue 
Velocity-Wert 127. Der Versuch, diesen Wert weiter 
hochzustufen, wird keinerlei Änderung bewirken.

Change Duration
Mit dem Change Duration-Befehl im Event 
Operations-Fenster können Sie die Dauer 
ausgewählter MIDI-Noten verändern. Verwenden 
Sie den Befehl, um die Artikulation der 
ausgewählten Noten zu ändern, indem Sie sie eher 
staccato oder eher legato gestalten.

Change Duration-Einstellungen

Mithilfe von MIDI-Echtzeit-Eigenschaften 
können Sie auch die Notenlänge nicht 
destruktiv ändern. Siehe „MIDI-Echtzeit-
Eigenschaften“ auf Seite 726.

Event Operations-Dialogfeld, Change Duration
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Set/Add/Subtract/Scale-Option

Set All To. – stellt die Dauer sämtlicher Noten auf 
einen in Viertelnoten und Ticks angegebenen 
Wert ein.

Add. – verlängert die Notendauer um die 
angegebene Anzahl von Viertelnoten und Ticks.

Subtract. – verkürzt die Notendauer um die 
angegebene Anzahl von Viertelnoten und Ticks.

Scale by. – verkürzt oder verlängert die 
Notendauer um einen in Prozent angegebenen 
Wert (1–400 %).

Legato

Aktivieren Sie die Legato-Option, um die MIDI-
Selektion mit Legato zu versehen. Wählen Sie im 
Legato-Popup-Menü Gap oder Overlap, und geben 
Sie die gewünschten Werte in Beats oder Ticks ein.

Remove Overlap

Die Remove Overlap-Option entfernt alle 
Überlappungen bei Noten derselben Tonhöhe. 
Dieser Befehl unterscheidet sich vom Legato 
insofern, als nicht überlappende Noten der 
gleichen oder unterschiedlicher Tonhöhe 
unverändert bleiben. Um eine Lücke (Gap) 
zwischen zuvor überlappenden Noten zu erstellen, 
geben Sie den Abstand in Beats und Ticks ein. 

Transform Sustain Pedal To Duration

Die Option Transform Sustain Pedal To Duration 
verlängert die Dauer aller Noten, die erklingen, 
wenn das Sustain-Pedal (Controller 64) bedient 
wird (64 bis 127), bis zu dem Punkt, an dem es 
losgelassen wird (0 bis 63). Aktivieren Sie die 
Delete Sustain Pedal Events-Option, um Sustain-
Pedal-Events in Notenlängen zu konvertieren. 
Diese Art der Konvertierung kann das Editing 
erheblich vereinfachen – und dennoch den 
gewünschten Performance-Effekt beibehalten. 
Wenn ein Sustain-Pedal-Event beim Editing 
einfach gelöscht wird, verliert die nachfolgende 
MIDI-Performance den Legato-Effekt.

Change Continuously-Option

Mit der Change Continuously-Option können Sie 
die Notenlänge kontinuierlich in Ticks oder nach 
Prozentwerten ändern. Benutzen Sie den Curve-
Schieber, um die Form der Änderung zu 
kontrollieren.

Change Continuously in Ticks. – bewirkt einen 
weichen Übergang zwischen unterschiedlichen 
Notenlängen innerhalb eines bestimmten 
Zeitraums. Der Wert für die Notendauer wird in 
Viertelnoten und Ticks eingegeben.

Change Smoothly by Percentage. – bewirkt einen 
weichen, prozentual definierten Übergang 
zwischen unterschiedlichen Notenlängen 
innerhalb eines bestimmten Zeitraums. 

Der Kurvenverlauf für diesen Übergang kann 
eingegeben werden (+/– 99). Der Wert legt fest, 
wie graduell der Übergang erfolgt.

Limit Range. – wenn diese Option ausgewählt ist, 
wird der Wertebereich für den Change Duration-
Befehl auf eine minimale und maximale 
Notendauer (angegeben in Viertelnoten und Ticks) 
beschränkt.

Die Einstellungen auf der Change Duration-
Seite werden mit jeder Session abgespeichert. 
Um bevorzugte Einstellungen für zukünftige 
Sessions als Standardeinstellungen zu 
verwenden, speichern Sie sie als Bestandteil 
einer Session-Vorlage (siehe „Session-
Vorlagen“ auf Seite 169).
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Randomize. – wenn diese Option ausgewählt ist, 
weicht die Dauer der Noten von dem unter Change 

Duration eingestellten Wert um einen 
eingegebenen Prozentwert nach dem 
Zufallsprinzip ab. Wenn Sie also beispielsweise 
bei der Set all to-Option einen Wert von 480 und 
bei „Randomize“ einen Wert von 50 % eingegeben 
haben, erhalten Sie nach dem Zufallsprinzip eine 
Dauer im Bereich zwischen 360 und 600 
(+/– 25 % der angegebenen Dauer).

Beispiele für die Optionen des 
Change Duration-Befehls

So lassen Sie Noten stärker staccato klingen:

1 Selektieren Sie den zu bearbeitenden MIDI-
Notenbereich.

2 Wählen Sie Event > Event Operations > 

Change Duration.

3 Wählen Sie die Scale By-Option und geben Sie 
einen Prozentwert von 50 ein.

4 Klicken Sie auf Anwenden. Die Dauer der 
selektierten Noten wird um 50 % verkürzt.

Bei dieser Option müssen Sie möglicherweise erst 
etwas mit den Prozentwerten experimentieren, 
bevor Sie das gewünschte Ergebnis erzielen.

So lassen Sie Noten stärker legato klingen:

1 Selektieren Sie den zu bearbeitenden MIDI-
Notenbereich.

2 Wählen Sie Event > Event Operations > 

ChangeDuration.

3 Wählen Sie die Legato-Option.

4 Wählen Sie im Legato-Popup-Menü die 
Overlap-Option.

5 Geben Sie als Wert der Überlappung 0|000 ein.

6 Klicken Sie auf Anwenden. 

Die Endpunkte der selektierten Noten werden bis 
zum Anfangspunkt der jeweils nächsten Note 
verlängert, sodass die Lücken zwischen den 
einzelnen Noten geschlossen werden.

Transpose
Während die Grabber-Tools zum manuellen 
Transponieren einzelner MIDI-Noten bzw. 
kleinerer Notengruppen verwendet werden 
können, können mit dem Transpose-Befehl im 
Event Operations-Fenster ganze MIDI-Spuren und 
Clips bearbeitet werden. Der Transpose-Befehl 
wird häufig verwendet, um die Tonart einer MIDI-
Spur zu ändern. Sie können für MIDI-Spuren, die 
Sie transponieren möchten, eine Edit-Gruppe 
erstellen, und dabei Schlagzeugspuren 
ausschließen, damit diese nicht ebenfalls 
transponiert werden. Transponieren ist sogar in 
einer Tonart möglich. 

Mithilfe der Polyphonic-, Rhythmic- oder X-
Form-Plug-Ins kann der Transpose-Befehl auch 
auf ganze Clips auf Elastic Audio-fähigen Spuren 
angewendet werden.

Drücken Sie Alt + P (Windows) oder Wahl + 
P (Mac), um das Change Duration-Fenster 
zu öffnen.

Mithilfe von MIDI-Echtzeit-Eigenschaften ist 
auch eine nicht destruktive Transposition von 
MIDI-Noten möglich. Siehe „MIDI-Echtzeit-
Eigenschaften“ auf Seite 726.

Informationen zum Transponieren von 
Elastic Audio-Clips finden Sie unter 
„Clipbasierte Tonhöhenänderungen mit 
Elastic Audio“ auf Seite 930.
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Transpose By (Octaves). – transponiert die 
ausgewählten MIDI-Noten um bis zu +/– 10 
Oktaven oder transponiert die ausgewählten 
Elastic Audio-Clips um bis zu +/– 2 Oktaven.

Transpose By (Semitones). – transponiert die 
ausgewählten MIDI-Noten um bis zu +/– 127 
Halbtöne nach oben oder unten oder transponiert 
die ausgewählten Elastic Audio-Clips chromatisch 
um bis zu +/– 48 Halbtöne (4 Oktaven) nach oben 
oder unten.

Transpose (From and To). – transponiert die 
ausgewählten MIDI-Noten oder die ausgewählten 
Elastic Audio-Clips um Halbtöne, ausgedrückt 
durch den Differenzwert zwischen ursprünglicher 
Tonhöhe und angestrebter Tonhöhe. Bei der 
Transposition von C3 nach F#3 werden die Noten 
beispielsweise um übermäßige Quarte (sechs 
Halbtöne) verlängert. 

Transpose All Notes To. – transponiert alle 
selektierten Noten auf dieselbe Tonhöhe. 
Verwenden Sie den Schieber oder das numerische 
Eingabefeld zur Eingabe der Tonhöhe, auf die alle 
ausgewählten Noten zu transponieren sind. Diese 
Option kann nicht für Elastic Audio-Clips 
verwendet werden.

Transpose In Key. – transponiert ausgewählte 
Noten in Tonleiterschritten nach oben oder nach 
unten (basierend auf dem Generalvorzeichen). 
Diese Option kann nicht für Elastic Audio-Clips 
verwendet werden.

So transponieren Sie MIDI-Noten:

1 Wenn Sie eine Gruppe von Spuren 
transponieren möchten, aktivieren Sie die Edit-
Gruppe.

2 Wählen Sie die gewünschten MIDI-Noten aus.

3 Wählen Sie Event > Event Operations > 

Transpose.

4 Wählen Sie die Transpose-Option (By, From 

and To, All Notes To oder In Key).

5 Legen Sie die entsprechenden Felder für die 
Tonhöhe fest.

Wenn eines der Eingabefelder für die Tonhöhe 
ausgewählt ist, können Sie den entsprechenden 
Tonhöhenwert auch direkt von Ihrem MIDI-
Controller aus einspielen.

6 Klicken Sie auf Anwenden.

Die Elastic Audio-Tonhöhenveränderung 
wird nicht im Zusammenhang mit dem 
Monophonic-Algorithmus unterstützt.

Die Tonhöhenänderung für Elastic Audio 
kann nicht auf Loop-Clips oder Clipgruppen 
angewendet werden.

Event Operations-Fenster, Transpose Drücken Sie Wahl + T (Mac) oder Alt + T 
(Windows), um das Transpose-Fenster zu öffnen.
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So transponieren Sie alle Noten auf einer Spur um 
eine Oktave nach unten:

1 Doppelklicken Sie mit dem Selector-Tool auf 
die Spur, um alle MIDI-Noten auszuwählen.

2 Wählen Sie Event > Event Operations > 

Transpose.

3 Wählen Sie die Transpose By-Option.

4 Geben Sie den Wert –1 im Oktaven-Feld ein.

5 Klicken Sie auf Anwenden.

So transponieren Sie ausgewählte Noten in der 
Tonart:

1 Wählen Sie die gewünschten MIDI-Noten aus.

2 Wählen Sie Event > Event Operations > 

Transpose.

3 Wählen Sie Transpose in Key.

4 Stellen Sie den Schieberegler auf die Anzahl 
von Tonleiterschritten (+ oder –) ein (oder 
geben Sie eine Zahl ein), um die die Selektion 
transponiert werden soll. Um beispielsweise um 
eine Terz nach unten zu transponieren, muss als 
Wert –2 eingegeben werden.

5 Klicken Sie auf Anwenden.

So transponieren Sie einen Elastic Audio-Clip:

1 Stellen Sie sicher, dass sich die zu 
transponierenden Clips auf Spuren mit 
aktiviertem Elastic Audio befinden.

2 Wählen Sie die entsprechenden Clips mit dem 
Grabber- oder Selector-Tool aus. Nur 
vollständig selektierte Clips sind von der 
Änderung betroffen.

3 Wählen Sie Event > Event Operations > 

Transpose.

4 Sie haben folgende Möglichkeiten:

• Passen Sie die Transpose By-Einstellungen um 
einen Betrag in Halbtönen und Cents an.

• Passen Sie die Transpose From- und -To-
Einstellungen um einen Betrag in Halbtönen und 
Cents an.

5 Klicken Sie auf Anwenden.

Die Elastic Audio-Tonhöhenveränderung 
wird nicht im Zusammenhang mit dem 
Monophonic-Algorithmus unterstützt.

Die Einstellungen „Transpose All Notes To“ 
und „Transpose In Key“ können nur auf 
MIDI-Noten angewendet werden. Wenn nur 
Audioclips ausgewählt sind, stehen diese 
Optionen nicht zur Verfügung.
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Select/Split Notes
Mit dem Select/Split Notes-Befehl im Event 
Operations-Fenster steht ein ganzes Toolset zum 
Auswählen und Teilen von MIDI-Noten anhand 
einer Reihe von Kriterien zur Verfügung. Mithilfe 
verschiedener zusätzlicher Tools können Sie 
bestimmen, ob die selektierten Daten in die 
Zwischenablage oder auf neue Spuren kopiert, ob 
die Daten auf eine einzige oder mehrere neue 
Spuren aufgeteilt werden sollen, usw. 

Select/Split Notes-Einstellungen

Pitch Criteria

All Notes. – selektiert alle Noten.

Notes Between. – selektiert einen Notenbereich 
zwischen der angegebenen höchsten und 
niedrigsten Note. Als Wert kann die Tonhöhe 
(C1–G8) oder die MIDI-Notennummer (0–127) 
eingegeben werden.

Oben. – selektiert die höchste(n) Note(n) in jedem 
Akkord.

Unten. – selektiert die niedrigste(n) Note(n) in 
jedem Akkord.

Andere Kriterien

Velocity. – aktivieren Sie die Velocity-Option zur 
Angabe eines Velocity-Bereichs zum Selektieren 
bzw. Splitten von Noten. Geben Sie die 
gewünschten Minimal- und Maximalwerte für die 
Velocity-Werte ein. 

Dauer. – aktivieren Sie die Duration-Option zur 
Angabe eines Duration-Bereichs (in Beats und 
Ticks) zum Selektieren bzw. Splitten von Noten. 
Geben Sie die gewünschten Minimal- und 
Maximalwerte für die Duration-Werte ein.

Position. – aktivieren Sie die Position-Option zum 
Selektieren oder Splitten aller Noten, die in einen 
Bereich relativer Beat- und Tick-Positionen in 
jedem Takt fallen. Der Mindestwert bestimmt den 
Ausgangswert, der maximale Wert den Endwert 
des zulässigen Bereichs.

Vorgang

Select Notes. – selektiert MIDI-Noten anhand der 
angegebenen Kriterien.

Split Notes: The Clipboard. – kopiert die 
selektierten Daten nur in die Zwischenablage.

Split Notes: A New Track. – kopiert die 
selektierten Daten auf eine einzige, neue Spur. 
Wenn die Selektion mehrere Spuren umfasst, wird 
eine identische Anzahl von Spuren erstellt. Die 
neuen Spuren duplizieren die ursprüngliche 
Spurart (Instrumenten- oder MIDI-Spur). 

Split Notes: A New Track per Pitch. – kopiert alle 
selektierten Daten auf mehrere neue Spuren (eine 
neue Spur je Tonhöhe). Neue Spuren zoomen auf 
Einzelnoten-Anzeige. Wenn die Selektion mehrere 
Spuren umfasst, werden die Daten für jede Spur 
separat aufgeteilt.

Event Operations-Fenster, Select/Split Notes
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Include All Continuous MIDI Data. – schließt alle 
kontinuierlichen MIDI-Daten, einschließlich 
Pitchbend und Aftertouch, auf der ganzen Spur 
ohne Beschränkung der zeitlichen Auswahl mit ein.

Auswählen und Teilen von Noten

So selektieren und teilen Sie Noten:

1 Sie haben folgende Möglichkeiten:

• Selektieren Sie mit dem Grabber- oder Selector-
Tool den MIDI-Notenbereich, der die 
gewünschten Noten enthält.

• Um alle MIDI-Noten einer Spur zu bearbeiten, 
setzen Sie durch Klicken mit dem Selector-Tool 
den Edit-Cursor in diese Spur.

2 Wählen Sie Event > Event Operations > 
Select/Split Notes. 

3 Konfigurieren Sie die Tonhöhenkriterien 
(Pitch Criteria).

4 Konfigurieren Sie die übrigen Kriterien 
(Velocity, Duration und Position).

5 Aktivieren Sie die Select- oder die Split-Option. 

6 Wählen Sie im Split Notes-Popup-Menü 
entweder die Copy- oder die Cut-Option. 

7 Wählen Sie beim Teilen von Noten die 
gewünschte Zielposition für die Copy- oder 
Cut-Option.

8 Aktivieren Sie beim Teilen von Noten die 
Include All Continuous MIDI Data-Option. Das 
Aktivieren dieser Option bewirkt, dass alle mit 
den geteilten Noten verbundenen Controller-
Daten in die neu erstellten Spuren aufgenommen 
werden. Lassen Sie diese Option deaktiviert, um 
nur Notendaten auf neue Spuren zu verteilen. 

9 Klicken Sie auf Anwenden. 

Sämtliche mit der Spur oder den Clips verknüpfte 
Echtzeit-Eigenschaften werden auf neue Spuren 
kopiert, die mit dem Select/Split Notes-Befehl 
erstellt wurden. 

Selektieren von Noten eines 
bestimmten Tonhöhenbereichs
Der Select/Split Notes-Befehl wird oft verwendet, 
um für die gesamte Länge eines Clips oder einer 
Spur eine einzelne Note zu selektieren. Dies ist 
besonders dann von Nutzen, wenn Sie eine Note 
auf einer MIDI-Schlagzeugspur (beispielsweise 
die Hi-Hat) selektieren möchten, um sie innerhalb 
eines bestimmten Zeitbereichs mit den Befehlen 
Quantize, Groove Quantize, Transpose oder 
Change Duration zu manipulieren.

So wählen Sie aus einer General MIDI-
Schlagzeugspur ausschließlich die Hi-Hats aus:

1 Sie haben folgende Möglichkeiten:

• Selektieren Sie mit dem Grabber- oder Selector-
Tool den MIDI-Notenbereich, der die 
gewünschten Noten enthält.

• Um alle MIDI-Noten einer Spur zu bearbeiten, 
setzen Sie durch Klicken mit dem Selector-Tool 
den Edit-Cursor in diese Spur.

2 Wählen Sie Event > Event Operations > 
Select/Split Notes.

3 Wählen Sie die Notes Between-Option und 
setzen Sie den Notenbereich auf F#1 und F#1 
(wenn die MIDI Note Display-Einstellung in den 
MIDI-Voreinstellungen auf Standard Pitch 
eingestellt ist).

Bei einem General MIDI-Schlagzeug ist die 
geschlossene Hi-Hat der MIDI-Note 42 (F#1 bei 
Standard Pitch) zugewiesen. Wenn die Hi-Hat in 
Ihrer Schlagzeugbelegung einem anderen 
Notenwert zugewiesen ist, geben Sie diesen ein.

4 Klicken Sie auf Anwenden.

Sie können mithilfe des Mini-Keyboards auch 
alle Noten einer bestimmten Tonart auf einer 
Spur auswählen. Weitere Informationen 
finden Sie unter „Selektieren von MIDI-
Noten“ auf Seite 700.
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Selektieren von Noten 
aus einem Akkord
Der Select/Split Notes-Befehl kann außerdem 
verwendet werden, um ausschließlich die höchsten 
oder tiefsten Noten eines Akkords zu wählen. Es 
kann vorkommen, dass Sie nur die höchsten oder 
tiefsten Noten in einem Akkord bearbeiten 
möchten, beispielsweise um deren Velocity-Werte 
zu erhöhen oder die Tonhöhe zu transponieren.

So selektieren Sie nur die tiefsten Noten 
eines Akkords:

1 Sie haben folgende Möglichkeiten:

• Selektieren Sie mit dem Grabber- oder Selector-
Tool den MIDI-Notenbereich, der die 
gewünschten Noten enthält.

• Um alle MIDI-Noten einer Spur zu bearbeiten, 
setzen Sie durch Klicken mit dem Selector-Tool 
den Edit-Cursor in diese Spur.

2 Wählen Sie Event > Event Operations > 

Select/Split Notes.

3 Wählen Sie die Bottom-Option und belassen 
Sie die Einstellung der Zahl der Noten bei 1.

4 Klicken Sie auf Anwenden.

Input Quantize
Wenn die Input Quantize-Option im Event 
Operations-Fenster aktiviert ist, werden alle 
aufgenommenen MIDI-Noten automatisch 
quantisiert.

So aktivieren Sie die Input Quantize-Option:

1 Wählen Sie Event > Event Operations > Input 
Quantize.

2 Wählen Sie auf der Input Quantize-Seite die 
Enable Input Quantize-Option.

3 Konfigurieren Sie die übrigen Optionen der 
Input Quantize-Seite. (Weitere Informationen 
zu Quantize-Optionen finden Sie unter 
„Quantize“ auf Seite 937.) 

4 Wenn Sie die Einstellungen vorgenommen haben, 
schließen Sie das Event Operations-Fenster.

Damit MIDI-Noten als Akkord interpretiert 
werden, dürfen deren Anfangspunkte 
höchstens 32 ppq-Ticks auseinander liegen.

Event Operations-Fenster, Input Quantize

Verwenden Sie „Input Quantize“ für Loop-
Aufnahmen im Stil einer Drum Machine 
(siehe „Loop-Aufnahme im MIDI Merge-
Modus“ auf Seite 491).
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Step Input
Mit dem Step Input-Befehl im Event Operations-
Fenster können Sie einzelne Noten schrittweise 
über einen MIDI-Controller eingeben. Dadurch 
erhalten Sie uneingeschränkte Kontrolle über die 
Platzierung, Länge und Velocity der Noten. Mit 
MIDI Step Input können Sie daher Passagen eines 
Musikstücks erstellen, die sonst nur äußerst 
schwer mit einer derartigen Präzision oder hohen 
Geschwindigkeit gespielt werden könnten. 

So geben Sie MIDI-Noten mit Step Input (über ein 
externes MIDI-Gerät) ein:

1 Vergewissern Sie sich, dass das externe MIDI-
Gerät ordnungsgemäß eingesteckt ist und mit 
Pro Tools kommuniziert.

2 Wählen Sie Event > Event Operations > Step 

Input.

3 Wählen Sie die Enable-Option.

4 Wählen Sie im Destination Track-Popup-Menü 
die MIDI- oder Instrumentenspur, auf die Sie 
aufnehmen möchten.

5 Wählen Sie im Step Increment-Bereich den 
Notenwert aus, den Sie eingeben möchten.

6 Spielen Sie eine Note oder einen Akkord auf 
Ihrem MIDI-Instrument. Dadurch geben Sie die 
Note ein und gehen automatisch zum nächsten 
Eingabeschritt.

So verlängern Sie eine Note, während Sie mit der 
Step Input-Funktion arbeiten:

1 Spielen Sie eine Note auf dem MIDI-Instrument 
und halten Sie sie.

2 Wählen Sie den Notenwert, den Sie hinzufügen 
möchten, und klicken Sie auf „Increment“.

Lassen Sie die Taste auf dem MIDI-Keyboard 
los und gehen Sie zum nächsten Einfügepunkt 
des Step Input-Modus.

Step Input-Fenster

Verwenden Sie Step Input, um MIDI-Noten in 
das Score Editor- oder MIDI Editor-Fenster 
einzugeben.

Wird Step Input aktiviert, werden alle zuvor 
scharfgeschalteten MIDI- oder 
Instrumentenspuren und alle eventuell 
definierten Default Thru-Instrumente 
deaktiviert.

Während eine Note auf dem MIDI-
Keyboard ausgehalten wird, wird 
anstelle von „Next Step“ „Increment“ 
angezeigt. 
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Steuerelemente für Step Input
Auf der Step Input-Seite befinden sich die 
folgenden Steuerelemente:

Enable. – wenn diese Option ausgewählt ist, 
werden die MIDI-Events der Zielspur beim 
Spielen auf dem externen MIDI-Keyboard 
hinzugefügt. Alle zuvor scharfgeschalteten MIDI-
Spuren werden deaktiviert. 

Wurde in den MIDI-Voreinstellungen ein Default 
Thru-Instrument definiert, wird es beim 
Aktivieren von Step Input deaktiviert und nach 
Verlassen des Step Input-Modus wieder aktiviert.

Destination. – hier können Sie aus einer Popup-
Liste mit allen Spuren in Ihrer Session die 
Zielspur auswählen, auf der Sie mit Step Input 
aufnehmen möchten. 

Steuerelemente im Step 
Increment-Abschnitt

Mit den Steuerelementen im Step Increment-
Abschnitt können Sie die Länge der mit Step Input 
eingegebenen MIDI-Events sowie die Abstände 
dazwischen festlegen. Dabei steht Ihnen das 
gesamte Spektrum zwischen ganzen Noten und 
Vierundsechzigstelnoten (einschließlich 
punktierter Noten) zur Verfügung. 

Tuplet. – hier können Sie abweichende 
Notengruppierungen wie Triolen und Quintolen 
eingeben. Die Tuplet-Länge wird aus den 
Einstellungen der Notengröße und des Tuplet-
Werts errechnet. Wenn beispielsweise eine 
Achtelnote 480 Ticks entspricht, ergibt ein 
Triolen-Achtel einen Notenabstand von 320 Ticks 
bzw. (480 Ticks/3) x 2.

Notenlänge. – hier können Sie die Länge der Note 
als Prozentsatz des Abstandwerts auswählen. 
Wenn beispielsweise eine Achtelnote 480 Ticks 
entspricht, ergibt eine Achtelnote von 80%iger 
Länge eine Dauer von 384 Ticks.

Step Input-Optionen

Use Input Velocity. – wenn diese Option 
ausgewählt ist, werden MIDI-Noten mit der 
Velocity aufgenommen, mit der Sie auf dem 
MIDI-Keyboard spielen.

Set Velocity To. – wenn diese Option ausgewählt 
ist, werden MIDI-Noten mit dem im Velocity-Feld 
angegebenen Wert aufgenommen. Dieser kann mit 
dem Velocity-Schieberegler eingestellt werden.

Enable Numeric Keypad Shortcuts. – wenn diese 
Option ausgewählt ist, können die Step Input-
Optionen über den Ziffernblock der Tastatur 
festgelegt werden. Siehe „Tastenkombinationen 
auf dem Ziffernblock“ auf Seite 965.

Undo Step, Next Step, Redo Step

Mit der Undo Step- und Next Step-Schaltfläche 
können Sie Folgendes ausführen:

• Verschieben des Einfügepunkts für Step Input, 
indem entweder die vorherige Note entfernt oder 
der Einfügepunkt um den Step Increment-Wert 
nach vorn verschoben wird

• Verlängern und Kürzen einer auf dem MIDI-
Controller gehaltenen Note, indem Step 
Increment-Werte hinzugefügt oder abgezogen 
werden; der Step Increment-Wert kann mitten in 
der Note geändert werden, um eine Note mit 
einer gemischten Länge zu erhalten

Mit der Redo Step-Schaltfläche können Sie 
sämtliche vorher mit der Undo-Funktion 
rückgängig gemachte Schritte wiederherstellen. 

Notenlänge in Prozent

100 % 80 % 120 %
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Undo Step. – wenn nach dem Loslassen der Taste 
zum Einspielen der vorherigen Note auf dem 
MIDI-Keyboard der Einfügepunkt bereits zur 
nächsten Note vorgerückt ist, kann mit Undo Step 
die gesamte vorherige Note entfernt werden.

Wenn eine Note auf dem MIDI-Keyboard gehalten 
wird, ändert sich die Beschriftung der Undo Step-
Schaltfläche in „Decrement“ und die letzte Step 
Increment-Länge, die der gehaltenen Note 
hinzugefügt wurde, wird entfernt.

Next Step. – wenn auf dem MIDI-Keyboard 
keine Note gehalten wird, wird durch Next Step der 
Einfügepunkt um den Step Increment-Wert 
verschoben, was de facto einer Pause gleichkommt.

Wenn hingegen eine Note auf dem MIDI-
Keyboard gehalten wird, ändert sich die 
Beschriftung der Next Step-Schaltfläche zu 
„Increment“ und der Step Increment-Wert wird 
der gehaltenen Note hinzugefügt, wodurch sie 
um diesen Wert verlängert wird. 

Während die Note gehalten wird, kann der Step 
Increment-Wert geändert werden, wodurch Sie 
Noten von beliebiger Länge erzeugen können.

Redo Step. – stellt die letzte durch „Undo Step“ 
entfernte Note wieder her. 

Auslösen der Undo Step-, 
Next Step- und Redo Step-
Schaltflächen
Die Undo Step-, Next Step- und Redo Step-
Schaltflächen können so eingestellt werden, dass 
sie von einem externen MIDI-Synth, Drum-Pad 
oder Controller ausgelöst werden. 

So stellen Sie MIDI-Trigger für „Undo Step“, „Next 
Step“ und „Redo Step“ ein:

1 Positionieren Sie den Edit-Einfügepunkt auf 
einer Spur an der Position, an der Sie die erste 
MIDI-Note eingeben möchten.

2 Wählen Sie Event > Event Operations > Step 

Input.

3 Klicken Sie in das Feld unter der Schaltfläche, 
der Sie das MIDI-Event zuweisen möchten.

4 Spielen Sie das MIDI-Event ein, das Sie als 
Trigger verwenden möchten. 

5 Drücken Sie zum Bestätigen der MIDI-Trigger-
Zuweisung die Eingabetaste.

Bei Verwendung eines Continuous 
Controller (wie etwa Pitch Bend) als 
Trigger sollten Sie extreme Controller-
Werte festlegen, um die versehentliche 
Eingabe von Daten zu vermeiden.
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Tastenkombinationen auf 
dem Ziffernblock
Wenn Enable Numeric Keypad Shortcuts 
ausgewählt ist, können zahlreiche Steuerelemente 
des Step Input-Fensters sowie Auswahloptionen über 
den Ziffernblock der Tastatur angewendet werden. 
:

Tastenkombinationen für 
Step Input

Key

Ganze Note 1

Halbe Note 2

1/4-Note 4

1/8-Note 5

1/16-Note 6

1/32-Note 7

1/64-Note 8

Punktierte Note . (Dezimaltaste)

n-Tole ein/aus 3

Nächster Schritt Eingabe

Undo Step 0

Nudge vorwärts +

Nudge zurück –

Hauptzähler auswählen =

Edit-Selektions-Anzeigen /
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Kapitel 42: HEAT

HEAT (Harmonically Enhanced Algorithm 
Technology) ist eine Softwareoption, 
die Pro Tools|HDX-Systemen ein „analoges 
Feeling“ verleiht.

HEAT wird auf alle aktiven Audiospuren in 
Ihrer Session angewendet und emuliert die 
Wirkung von Magnetbändern kombiniert mit 
Obertoncharakteristika, wie sie bei analogen 
Mischpulten vorkommen. Mithilfe von HEAT 
können Sie Ihren Mischungen eine warme, 
analog modellierte Verzerrung mit weicher 
Sättigung hinzufügen.

Aktivieren von HEAT
Wenn Sie HEAT aktivieren, wird es auf alle 
aktiven Audiospuren in Ihrer Session angewendet. 
Dadurch wird der Effekt eines analogen 
Mischpults emuliert. HEAT wird mit allen Mono-, 
Stereo- und Surround-Formaten bereitgestellt. 
Mithilfe von HEAT können Sie Ihren Mischungen 
eine warme, analog modellierte Verzerrung mit 
weicher Sättigung hinzufügen.

HEAT benötigt DSP-Ressourcen für alle aktiven 
Audiospuren. Dies ist von Bedeutung, da mit 
zunehmender bzw. abnehmender Anzahl von 
Audiospuren entsprechend mehr bzw. weniger 
DSP-Ressourcen benötigt werden, damit HEAT 
seine volle Wirkung entfalten kann. HEAT belegt 
keine DSP-Ressourcen auf inaktiven Audiospuren.

Es gibt folgende Möglichkeiten, HEAT in einer 
Session zu aktivieren oder zu deaktivieren:

 Aktivieren bzw. deaktivieren Sie Options > 

Activate HEAT.

 Aktivieren bzw. deaktivieren Sie im Mix-
Fenster der HEAT-Ansicht die HEAT On/Off-
Schaltfläche.

Mithilfe der Enable HEAT in New Sessions-
Option in den Pro Tools-Voreinstellungen 
können Sie HEAT automatisch für alle neuen 
Sessions aktivieren.

So aktivieren bzw. deaktivieren Sie HEAT für 
neue Sessions:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf die Processing-Registerkarte.

3 Aktivieren oder deaktivieren Sie in der 
DSP Management-Sektion die Enable HEAT 

in New Sessions-Option.

4 Klicken Sie auf OK.



Pro Tools-Referenzhandbuch968

Verarbeitungsvorgänge 
in HEAT
In HEAT stehen die beiden globalen 
Steuerelemente „Drive“ und „Tone“ zur 
Verfügung. Sie wirken sich auf alle Audiospuren 
aus, für die HEAT nicht auf Bypass geschaltet ist.

Drive
Das Drive-Steuerelement bewirkt eine nichtlineare 
Verarbeitung, die Aufzeichnungen auf 
Magnetbändern sowie Obertoncharakteristika 
emuliert, wie sie bei Analogausrüstung 
häufig vorkommen. 

Wenn Sie das Drive-Steuerelement gegen den 
Uhrzeigersinn drehen, emuliert HEAT eine 
nichtlineare Verzerrung, wie sie bei Tonbändern 
auftritt. Wie bei Tonbändern steigt durch Drehen 
des Drive-Steuerelements gegen den Uhrzeigersinn 
mit zunehmendem Pegel der Obertonanteil; 
ungerade Obertöne mit höheren Frequenzen 
kommen hinzu (beginnend mit den Obertönen 
3 und 5). Weiters emuliert HEAT auch die 
Aufnahme- und Wiedergabe-Equalizer von 
Bandmaschinen, was zu einer zusätzlichen 
Anpassung der Obertöne führt. Auf diese Weise 
erhalten Sie beim Drehen des Drive-Steuerelements 
gegen den Uhrzeigersinn einen zunehmend 
voluminösen Klang der bearbeiteten Audiodatei in 
den tiefen und mittleren Lagen, während 
hochfrequente Signalspitzen geglättet werden. 

Wenn Sie das Drive-Steuerelement im 
Uhrzeigersinn drehen, erhalten Sie eine 
aggressivere Wirkung: Zu den ungeraden 
Obertönen kommt eine Folge gerader Obertöne 
hinzu, wie sie bei Triodenröhren vorkommt. 
Dadurch erzielen Sie die Wirkung hochwertiger 
Röhrenmikrofone und anderer Analoggeräte, 
bei denen Röhren zum Einsatz kommen. 

Die Obertonstruktur variiert dabei in Abhängigkeit 
vom Signalpegel und von der Stärke des 
angewendeten Effekts – genau wie bei 
Vakuumröhren bei analogen Verfahren.

Tone
Wie bei Bandgeräten kann eine Übersteuerung 
zum Verlust hoher im Verhältnis zu tiefen 
Frequenzen führen, da bei Ersteren die 
Komprimierung früher einsetzt. HEAT kann je 
nach Programmmaterial und dessen Pegel diese 
Verluste ausgleichen, Details deutlicher 
hervortreten lassen und den Klang bis zu einem 
gewissen Grad aufhellen. Durch Drehen des Tone-
Steuerelements treten Details deutlicher 
(im Uhrzeigersinn) oder weniger deutlich 
(gegen den Uhrzeigersinn) hervor und es entsteht 
ein hellerer oder dunklerer Klang.

Abhängig von der Drive-Einstellung hat Tone eine 
unterschiedliche Wirkung. Dieses Steuerelement 
verändert – im Gegensatz zu entsprechenden 
Funktionen bei Equalizern – die Stärke und 
den Charakter des Obertonanteils auf 
nichtlineare Weise.

Verarbeitung mit HEAT
HEAT reduziert bei der Verarbeitung 
Signalspitzen und verstärkt zugleich den Anteil an 
Obertönen mit niedrigem Pegel. Der Pegel 
vorhandener Signalspitzen wird also gesenkt. Dies 
ist vergleichbar mit dem „Soft Clipping“ (weiche 
Übersteuerung) bei Röhren oder Bändern, wobei 
die Spitzen gestaucht werden und analoge 
Komprimierung über einen großen dynamischen 
Bereich eintritt.
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In welchem Maß sollte das Material 
verarbeitet werden?

Die Verarbeitung mit HEAT ist pegel- und 
programmabhängig. In den meisten Fällen genügt 
eine allgemeine Einstellung für viele Quellen. 
Manche Einstellungen sind aber nur für bestimmte 
Quellen optimal und haben bei anderen nicht die 
gewünschte Wirkung. Wenn Sie eine vielseitig 
verwendbare Einstellung benötigen, drehen Sie 
das Drive-Steuerelement um zwei Schritte im oder 
gegen den Uhrzeigersinn.

Ihr Gehör ist möglicherweise nicht an die von 
HEAT bewirkten Veränderungen des 
Obertonanteils gewöhnt. In diesem Fall empfiehlt 
es sich, das mit HEAT verarbeitete 
Programmmaterial für einige Zeit abzuhören und 
sich zu „akklimatisieren“. Im richtigen Maß sind 
zusätzliche Obertöne angenehm für das 
menschliche Gehör. Experimentieren Sie mit 
verschiedenen Einstellungen, bis Sie den 
optimalen Klang gefunden haben. 

Nachdem Sie sich an den Klang des mit HEAT 
verarbeiteten Programmmaterials gewöhnt haben, 
können Sie HEAT deaktivieren und sich im 
direkten Vergleich die feinen, aber deutlichen 
Unterschiede bewusst machen.

Eine unterschiedlich stark ausgeprägte 
Verarbeitung mit HEAT bewirkt je nach Art des 
Programmmaterials und nach Aufnahmeverfahren 
höchst unterschiedliche Effekte – von kaum 
wahrnehmbaren bis hin zu drastischen 
Veränderungen. Auch zwischen der Verarbeitung 
analoger und digitaler Aufnahmen können nur 
leichte oder ganz erhebliche Unterschiede 
bestehen. Die Wirkung von HEAT ist bei Material 
von „transparenterer“ Struktur eventuell einfacher 
wahrzunehmen als bei „dichterem“ Material. Auch 
der Anteil hinzukommender tiefer Frequenzen 
beeinflusst das hörbare Ergebnis.

HEAT-Steuerelemente
In HEAT stehen einfache Master-Steuerelemente 
zur Abstimmung der Klangfarbe sowie eine 
Gruppe von Steuerelementen für die einzelnen 
Audiospuren in der Session zur Verfügung.

HEAT-Master-Steuerelemente
Mithilfe der HEAT-Master-Steuerelemente 
können Sie die Stärke und die Klangfarbe der 
Effekte bestimmen, die durch die Verarbeitung 
sämtlicher Audiospuren mit HEAT erzielt werden. 
Experimentieren Sie mit unterschiedlichen 
Einstellungen, bis die Klangfarbe der Mischung 
Ihren Vorstellungen entspricht.

On/Off (HEAT). – aktiviert oder deaktiviert HEAT 
in der Pro Tools-Session.

Bypass (BYPASS). – schaltet die Verarbeitung mit 
HEAT auf Bypass, ohne HEAT zu deaktivieren. 
Die für HEAT benötigten DSP-Ressourcen 
werden dabei nicht freigegeben.

Pegelanzeige. – zeigt bei der Verarbeitung 
sämtlicher Audiospuren mit HEAT einen 
Durchschnittswert für das Ausmaß an, in dem diese 
Verarbeitung auf den einzelnen Spuren erfolgt.

HEAT-Master-Steuerelemente
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Drive. – hier können Sie einstellen, wie stark Drive 
in HEAT angewendet werden soll. Diese Funktion 
emuliert die Verzerrung, die beim Übersteuern 
eines Analogkanalzugs an einer Konsole entsteht. 
In der Standardeinstellung (12 Uhr) erfolgt keine 
Verarbeitung mit HEAT. Indem Sie den Regler 
gegen den Uhrzeigersinn drehen, fügen Sie der 
Mischung ungeradzahlige Obertöne hinzu (ein der 
Bandsättigung ähnlicher Effekt). Durch Drehen 
des Reglers im Uhrzeigersinn fügen Sie den 
ungeradzahligen geradzahlige Obertöne hinzu und 
simulieren eine Triodenröhre.

Tone. – mithilfe dieses Steuerelements regeln Sie 
die Klangfarbe (Bässe und Höhen) in HEAT. 
Durch Drehen des Steuerelements nach rechts 
erhalten Sie einen helleren, durch Drehen nach 
links einen dunkleren Klang.

Ein- und Ausblenden der HEAT-Master-
Steuerelemente

Die HEAT-Master-Steuerelemente können im 
Mix-Fenster angezeigt werden. 

So blenden Sie HEAT-Master-Steuerelemente ein 
(oder aus):

 Klicken Sie in der rechten unteren Ecke des Mix-
Fensters auf die Schaltfläche zum Ein-
/Ausblenden von HEAT-Master-Steuerelementen.

HEAT-Spur-Steuerelemente
HEAT-Spur-Steuerelemente stehen für alle 
Audiospuren zur Verfügung. HEAT wirkt sich nur 
auf Audiospuren aus.

Bypass (BYP). – schaltet die Verarbeitung mit 
HEAT für die betreffende Audiospur auf Bypass. 
Die für HEAT auf dieser Spur benötigten DSP-
Ressourcen werden dadurch nicht freigegeben.

Pre-/Post-Insert (PRE). – legt fest, ob die 
Verarbeitung der betreffenden Spur mit HEAT vor 
oder nach den Inserts erfolgen soll. Wenn die PRE-
Schaltfläche leuchtet, erfolgt die Verarbeitung mit 
HEAT zuerst.

Pegelanzeige. – zeigt an, in welchem Umfang die 
betreffende Audiospur mit HEAT verarbeitet wird. 
Auf Spuren mit mehreren Kanälen wird hier ein 
Durchschnittswert für das Ausmaß angezeigt, 
in dem die Kanäle auf der betreffenden Spur mit 
HEAT verarbeitet werden.

Ein- und Ausblenden der HEAT-Spur-
Steuerelemente

Die HEAT-Spur-Steuerelemente können im Mix-
Fenster angezeigt werden. 

Führen Sie zum Einblenden (oder Ausblenden) der 
HEAT-Spur-Steuerelemente einen der folgenden 
Schritte durch:

 Aktivieren bzw. deaktivieren Sie View > Mix 
Window Views > HEAT.

Schaltfläche zum Ein-/Ausblenden von HEAT-Master-
Steuerelementen im Mix-Fenster

HEAT-Spur-Steuerelemente
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 Aktivieren bzw. deaktivieren Sie im Mix 
Window View-Selektor HEAT.

Bypass-Anzeigen für Master 
und Spuren
Durch farbige Hervorhebung der Bypass-
Schaltfläche der Spur wird angezeigt, ob HEAT 
explizit oder implizit über den Master Bypass auf 
Bypass geschaltet ist. Bei Spuren, die explizit auf 
Bypass geschaltet sind, bleibt diese Einstellung 
erhalten, wenn der Master Bypass deaktiviert wird.

Wenn eine Spur explizit auf Bypass geschaltet ist, 
wird ihre Schaltfläche in Hellorange angezeigt.

Wenn Master Bypass aktiviert ist, wird die 
dazugehörige Schaltfläche in Hellorange angezeigt. 
Die BYP-Schaltflächen aller implizit auf Bypass 
geschalteten Spuren werden dunkelorange.

Hinweis zu anderen Spurarten
HEAT wirkt sich nur auf Audiospuren aus. 
Für Instrumenten-, Auxiliary-Eingangs- oder 
Master-Spuren kann HEAT nicht verwendet werden. 
Wenn Sie Plug-Ins für virtuelle Instrumente auf 
Instrumenten- oder Auxiliary-Eingangs-Spuren 
verwenden und HEAT anwenden möchten, können 
Sie entweder Audio von der betreffenden Spur über 
einen Bus auf einer Audiospur aufnehmen oder das 
auf dieser Spur ausgegebene Material über einen Bus 
zum Eingang einer Audiospur leiten und das 
Eingangs-Monitoring aktivieren.

DSP- und Voice-Anforderungen
Die Menge der von HEAT genutzten DSP-
Ressourcen basiert auf der Anzahl der Voices, 
die für Audiospuren verwendet werden, dem DSP-
Hardwaretyp und der Session-Samplerate.

Die folgende Tabelle zeigt die Anzahl der 
verfügbaren Mono-Audiospuren pro DSP-Chip, 
wenn HEAT aktiviert ist. 

Für Stereospuren ist zweimal so viel DSP-
Kapazität erforderlich wie für Monospuren, 
Surround-Formate benötigen für jeden ihrer 
Kanäle die DSP-Kapazität einer Monospur. 
So benötigen Sie z. B. für eine 5.1-Spur die 
Kapazität von sechs Monospuren.

Wählen von HEAT im Mix Window View-Selektor

HEAT-Spur- und -Master-Steuerelemente mit auf 
Bypass geschalteter Spur

HEAT-Spur- und -Master-Steuerelemente mit Master-
Bypass

Verfügbare Anzahl von Mono-Audiospuren pro DSP-
Chip

DSP-
Chip-Typ

44,1/48 
kHz

88,2/96 
kHz

176,4/192
kHz

HDX 86 42 19
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Nicht genügend DSP-
Ressourcen
Wenn HEAT aktiviert ist, reichen die DSP-
Ressourcen Ihres Systems eventuell nicht aus, 
um der Session weitere Audiospuren 
hinzuzufügen (da auf den neuen Spuren nicht 
genügend DSP-Kapazität für HEAT vorhanden 
ist). In diesem Fall erhalten Sie von Pro Tools die 
Aufforderung, einen der folgenden Schritte 
auszuführen:

• die neuen Spuren erstellen und diese 
inaktiv schalten (inaktive Spuren belegen keine 
DSP-Ressourcen);

• HEAT deaktivieren und die neuen Spuren 
erstellen.

Wenn Sie eine Session öffnen, die gespeichert 
wurde, während HEAT aktiviert war, die DSP-
Kapazität Ihres Systems jedoch nicht ausreicht, 
um HEAT auf alle aktiven Audiospuren in der 
Session anzuwenden, wird HEAT automatisch 
deaktiviert. Im Dialogfeld mit den Session-
Notizen wird angezeigt, dass HEAT inaktiv 
geschaltet wurde.

Sobald die Session geöffnet ist, können Sie die 
Spuren verwalten und unter Berücksichtigung der 
auf Ihrem System verfügbaren DSP-Kapazität 
festlegen, welche Spuren aktiv sein sollen, wobei 
HEAT für diese Spuren aktiviert ist. Sie können 
auch Ihr Avid HDX-System um zusätzliche 
Karten erweitern, um mehr DSP-Ressourcen für 
HEAT bereitzustellen.

In Sessions mit zahlreichen aktiven DSP-Plug-Ins 
wird HEAT beim Öffnen zwar vielleicht aktiviert, 
es werden dabei aber einige der DSP-Plug-Ins 
deaktiviert. Dies liegt daran, dass die Bearbeitung 
mit HEAT Vorrang vor der Bearbeitung mit DSP-
Plug-Ins hat.

Voice-Anforderungen
Wenn auf einer Spur Pre-Insert für HEAT 
festgelegt wurde und das erste Plug-In auf dieser 
Spur ein Native-Plug-In ist, sind zum Aktivieren 
von HEAT zusätzliche Voices erforderlich. HEAT 
kann nur aktiviert werden, wenn genügend Voices 
verfügbar sind.

Wenn HEAT bereits mit der Post-Insert-Einstellung 
aktiv ist und das erste Plug-In auf dieser Spur ein 
Native-Plug-In ist, werden zusätzliche Voices 
benötigt, wenn HEAT auf Pre-Insert umgeschaltet 
werden soll. Sind nicht genügend Voices verfügbar, 
ist die PRE-Schaltfläche inaktiv. Sie kann erst 
wieder verwendet werden, wenn Sie (in der 
Playback Engine) mehr Voices einrichten oder 
wenn Sie Voices verfügbar machen, z. B. durch 
Deaktivieren einiger Audiospuren.

Verwenden von HEAT mit 
einer Bedienoberfläche
(Nur ICON und C|24)

Sie können HEAT mithilfe der folgenden 
Funktionen von ICON (D-Control und D-
Command) und C|24 steuern. 

D-Control und D-Command
Bei D-Control oder D-Command haben Sie über 
die Custom Faders-Sektion Zugriff auf die HEAT-
Master-Steuerelemente und direkt über die 
Kanalzüge Zugriff auf die Channel-
Steuerelemente von HEAT. 

Informationen zur Verwendung von HEAT 
mit Avid Artist und Bedienoberflächen der 
Pro-Serie erhalten Sie im Pro Tools-
EUCON-Handbuch.
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Master-Steuerelemente

Die HEAT-Master-Steuerelemente sind „On/Off“, 
„Bypass“, „Drive“ und „Tone“. 

So greifen Sie von D-Control oder D-Command 
aus auf HEAT-Master-Steuerelemente zu:

 Drücken Sie Umschalt + Strg für den Plug-Ins-
Schalter in der Custom Fader-Sektion. 

HEAT erstellt einen Custom Fader für HEAT und 
weist Steuerelemente wie im Folgenden 
beschrieben den mittleren Drehgebern zu. 

D-Control 

Bei D-Control stehen HEAT-Master-
Steuerelemente in einem einzelnen Custom Fader 
(Nr. 8) zur Verfügung.

D-Command (Custom Fader 7 und 8)

Bei D-Command stehen HEAT-Master-
Steuerelemente in den Drehgeber-Sektionen 
zweier Custom Fader (7 und 8) zur Verfügung. 

Bypass und Pre/Post für HEAT auf 
einzelnen Kanälen

Wenn HEAT in einer Session aktiviert ist, stehen 
in jedem Kanalzug die Optionen für Bypass und 
Pre/Post zur Verfügung. Auf diese Channel-
Einstellungen für HEAT haben Sie direkt über die 
Kanalzüge von D-Control und D-Command 
Zugriff. Die Channel-Steuerelemente für HEAT 
berücksichtigen die Einstellungen „Do To All“ 
und „Do to All Selected“. 

So greifen Sie im Kanalzug auf HEAT zu:

1 Achten Sie darauf, dass HEAT in der Session 
aktiviert ist. 

2 Drücken Sie Umschalt + Strg für den Kanal-
Inserts-Schalter. 

HEAT-Master-Steuerelemente bei D-Control

Drehgeber Parameter Vorgang

3 HEAT (On/Off) Drehgeber drehen 
oder BMP-Schalter 
des Drehgebers 
3 drücken, 
um zwischen 
Einstellungen zu 
wechseln

4 MstByp 
(Master Bypass)

Drehgeber drehen 
oder BMP-Schalter 
des Drehgebers 
4 drücken, 
um zwischen 
Einstellungen zu 
wechseln

5 Drive Drehgeber drehen

6 Tone Drehgeber drehen

HEAT-Master-Steuerelemente bei D-Control

Drehgeber Parameter Vorgang

1
(Fader 7)

HEAT (On/Off) BMP-Schalter 
drücken, 
um zwischen 
Einstellungen zu 
wechseln, oder 
Drehgeber drehen

2
(Fader 7)

MstByp 
(Master Bypass)

BMP-Schalter 
drücken, 
um zwischen 
Einstellungen zu 
wechseln, oder 
Drehgeber drehen

1
(Fader 8)

Drive Drehgeber drehen

2
(Fader 8)

Tone Drehgeber drehen
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D-Control

Bei D-Control sind die Drehgeber/BMP-
Schalter 5 und 6 den HEAT-Funktionen Pre/Post 
und Bypass zugewiesen. 

So schalten Sie zwischen Pre- und Post-Insert 
(HEAT) auf einem Kanal um: 

 Sie haben folgende Möglichkeiten: 

• Drehen Sie den Drehgeber 5.

• Drücken Sie den BMP-Schalter für 
Drehgeber 5. 

So schalten Sie HEAT auf einem Kanal auf Bypass 
bzw. heben dies auf: 

 Sie haben folgende Möglichkeiten: 

• Drehen Sie den Drehgeber 6.

• Drücken Sie den BMP-Schalter für 
Drehgeber 6. 

D-Command

Bei D-Command sind beide Kanaldrehgeber und 
die dazugehörigen BMP-Schalter den HEAT-
Funktionen Pre/Post (obere Drehgeberreihe) und 
Bypass (untere Drehgeberreihe) zugewiesen. 

So schalten Sie HEAT auf einem Kanal auf Bypass 
bzw. heben dies auf: 

 Sie haben folgende Möglichkeiten: 

• Drehen Sie den unteren Drehgeber.

• Drücken Sie den BMP-Schalter des unteren 
Drehgebers. 

So schalten Sie zwischen Pre- und Post-Insert 
(HEAT) auf einem Kanal um: 

 Sie haben folgende Möglichkeiten: 

• Drehen Sie den oberen Drehgeber.

• Drücken Sie den BMP-Schalter des 
oberen Drehgebers. 

HEAT unterstützt den Flip-Modus für seine 
Master- und Channel-Steuerelemente. 
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C|24
Bei C|24 können Sie die HEAT-Master-Steuerelemente über die Drehgeber 21–24 und die HEAT-
Channel-Steuerelemente über die einzelnen Kanalzüge bedienen. 

Master-Steuerelemente

So greifen Sie bei C|24 auf die HEAT-Master-Steuerelemente zu: 

 Drücken Sie den Soft Keys-Schalter in der Kanalleiste. Zum Verlassen dieses Modus drücken Sie den 
Soft Keys-Schalter erneut.

HEAT-Master-Steuerelemente sind den Drehgebern und dazugehörigen Schaltern der Kanalzüge 
21–24 zugeordnet, wie unter Tabelle 1 auf Seite 975 gezeigt.

Bypass und Pre/Post für HEAT auf einzelnen Kanälen

Wenn HEAT in einer Session aktiviert ist, stehen in jedem Kanalzug die Optionen für Bypass und Pre/Post 
zur Verfügung. Auf diese Channel-Einstellungen haben Sie direkt über die Kanalzüge von C|24 Zugriff. 
Die Channel-Steuerelemente für HEAT berücksichtigen die Einstellungen „Do To All“ und „Do to 
All Selected“. 

So greifen Sie auf HEAT-Channel-Steuerelemente zu:

1 Vergewissern Sie sich, dass HEAT in der aktuellen Session aktiviert ist. 

2 Halten Sie im Kanalzug den Inserts-Schalter für den Kanal gedrückt. Drücken Sie zum Verlassen dieses 
Modus denselben Schalter erneut.

So schalten Sie HEAT auf einem Kanal auf Bypass bzw. heben dies auf: 

 Drücken Sie den Bypass-Schalter des Kanals. 

So schalten Sie zwischen Pre- und Post-Insert (HEAT) auf einem Kanal um: 

Drehen Sie den Drehgeber oder drücken Sie den dazugehörigen Schalter und wählen Sie „Pre“ oder „Post“.

Tabelle 1. HEAT-Master-Steuerelemente auf C|24

Drehgeber 21 22 23 24

Parameter
HEAT (On/Off) MstByp (Master 

Bypass)
Drive Tone

Vorgang

Schalter des 
Drehgebers 
drücken, um 
umzuschalten

Schalter des 
Drehgebers 
drücken, um 
umzuschalten

Drehgeber drehen Drehgeber 
drehen
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Kapitel 43: Einfaches Mixen

Dieses Kapitel befasst sich mit den Grundlagen 
des Mischens in Pro Tools. Behandelt werden der 
Signalfluss der Audiosignale, u. a. Ausgänge, 
Busse, Inserts und Sends für Submixe und 
Mixdown.

Vor dem endgültigen Mixdown können schon 
während einer Session verschiedene 
Mischvorgänge anfallen. 

Während des Mischens ermöglichen Echtzeit-
Plug-Ins und Hardware-Inserts die Verwendung 
von Effekten und die Verarbeitung von Signalen 
(siehe Kapitel 44: „Plug-In- und Hardware-
Inserts“). 

Grundbegriffe des Mischens
Beim Mixing sind Faktoren wie Lautstärke, 
Panoramaregelung (Panning) und Effekte in Ihrem 
Studio zu berücksichtigen. Während Sie viele 
dieser Faktoren (etwa Lautsprecher und 
Raumakustik) im Studio steuern können, haben 
Sie keinen Einfluss auf die Umgebung, in der die 
Mischung schließlich gehört wird. Die folgenden 
Hinweise helfen Ihnen sicherzustellen, dass Ihre 
Mischung für möglichst viele Hörer möglichst gut 
klingt:

Monitoring mit verschiedenen Lautsprechern – 
hören Sie Ihre Mischungen auf verschiedenen 
Lautsprechern, um abzuschätzen, wie gut sie auf 
unterschiedlichen Wiedergabesystemen klingen.

Referenzmischungen – erstellen Sie Audio-CDs 
und MP3-kodierte Dateien von Rohmischungen und 
hören Sie sie in unterschiedlichen akustischen 
Umgebungen außerhalb des Studios ab.

Überprüfen auf Formatkompatibilität – 
überprüfen Sie Stereomischungen auf 
Kompatibilität mit Mono-Wiedergabesystemen 
und Mehrkanal-Surround-Mischungen auf 
Kompatibilität mit Stereo-Wiedergabesystemen.

Skalenanzeigen und 
Kalibrierung
Anzeigen dienen zur optischen Darstellung der 
Signalpegel. Sie geben an, ob ein Signal einen 
Kanal erreicht und wie stark oder schwach ein 
Signal im Bezug auf den Nullwert (d. h. über oder 
unter 0) ist. 

Wenn Sie Ihr gesamtes Equipment auf 
Standardreferenzpegel kalibrieren, wird auf den 
unterschiedlichen Aufnahmegeräten eines Studios, 
einer Produktionsstätte oder der ganzen 
Produktionskette ein gleichbleibender Pegel 
erreicht (und angezeigt). Beispielsweise sollte ein 
Signal mit einem Ausgangspegel von –18 dBFS 
auf einem DAT-Rekorder auch in Pro Tools mit 
–18 dBFS wiedergegeben und angezeigt werden.
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Kalibrieren von Audio-Interfaces
(Nur HD I/O)

Wenn Sie ein Pro Tools|HDX oder Pro Tools|HD-
Native-System mit einem HD I/O-Audio-Interface 
nutzen, verwenden Sie die Calibration Reference 
Level-Option (auf der Operation Preferences-
Registerkarte), um den Referenzpegel 
einzustellen, wenn Pro Tools sich im Calibration-
Modus befindet.

Signalfluss nach Spurart
Pro Tools unterstützt die folgenden Spurarten:

• Audio

• Auxiliary-Eingang

• Master-Fader

• MIDI

• Instrument

• VCA Master (nur Pro Tools HD)

Audio-, Auxiliary-Eingangs-, Master-Fader- und 
Instrumentenspuren können Audiosignale routen. 
MIDI- und Instrumentenspuren können MIDI-
Daten routen. 

VCA Master-Spuren leiten keine Audio- oder 
MIDI-Daten weiter, wirken sich jedoch auf 
Einstellungen auf anderen Spuren aus. Siehe 
„VCA Master-Spuren“ auf Seite 985. 

Die einzelnen Spuren sind im Mix-Fenster durch 
ihr Spurart-Symbol gekennzeichnet.

Audiospuren und Signalfluss
Audiospuren spielen Audio von der Festplatte ab, 
zeichnen Audiodaten auf der Festplatte auf und 
spiegeln Eingangssignale wider, wenn sie 
scharfgeschaltet sind oder sich im TrackInput-
Abhörmodus befinden. Inserts auf Audiospuren 
sind Pre-Fader. Sends auf Audiospuren können als 
Pre- oder Post-Fader eingesetzt werden.

Mono- und Stereo-Audiospuren sind auf allen 
Pro Tools-Systemen verfügbar. 

Mehrkanal-Audiospuren und Surround-
Mischformate werden nur von Pro Tools HD 
unterstützt.

Anleitungen zum Kalibrieren eines HD I/O-
Audio-Interface finden Sie im HD I/O-
Handbuch.

Audio-, Auxiliary-Eingangs-, Master-Fader-, 
VCA Master-, MIDI- und Instrumentenspuren

Informationen zum Erstellen von Spuren 
finden Sie unter „Erstellen von Spuren“ auf 
Seite 219.

Spurartsymbole
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Auxiliary-Eingangs-Spuren 
und Signalfluss
Auxiliary-Eingangs-Spuren bieten die gleichen 
Möglichkeiten zum Signal-Routing wie 
Audiospuren, außer dass die Eingangssignale von 
einem internen Bus oder Hardware-Eingang 
stammen müssen. Inserts auf Auxiliary-Eingängen 
sind Pre-Fader-Inserts.

Signalfluss des Audiosignals, Audiospur

 

 

 Source
oder
Input

HEAT-Option, Pre-Insert

Quelle: eine beliebige, von der 
Festplatte abgespielte Mono-, 
Stereo- oder Mehrkanalaudiodatei

Eingang: während des 
Aufnahme- oder 
Spureingangs-Monitorings

HEAT-Option, Post-Insert

Sends, Pre-Fader

Inserts 
(Plug-Ins 
oder 
Hardware-
Inserts)

Input 
Solo

Aufnahme
Stumm-
schaltung

Volume

Sends, Post-Fader

Main-Ausgang 

+ zusätzlich 
Ausgänge

Output

Panner

Signalfluss des Audiosignals, Auxiliary-Eingangs-
Spur

 

Input
Quelle: Bus oder 
Hardware-Eingangspfad

Inserts 
(Plug-Ins 
oder 
Hardware-
Inserts) Sends, Pre-Fader

Solo

Volume 

Stumm-
schaltung

Sends, Post-Fader

Panner

Output Main-
Ausgang

+ zusätzliche 
Ausgänge 
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Auxiliary-Eingangs-Spuren werden als Eingänge 
für Audiosignale von einem externen MIDI-
Instrument und anderen Quellen verwendet. 
Außerdem nutzt man sie für Submixe interner Bus- 
und Ausgangspfade. Sie lassen sich vollständig 
automatisieren. Wenn Sie Auxiliary-Eingangs-
Spuren als Eingänge für externe Quellen 
verwenden, müssen Sie die Ausgangspegel der 
Quelle so einstellen, dass gute Aufnahmepegel 
erreicht werden. 

Verwendungszwecke für 
Auxiliary-Eingänge
Auxiliary-Eingänge bieten folgende 
Nutzungsmöglichkeiten:

• Anwenden von Echtzeit-Plug-Ins oder eines 
externen Prozessors auf den Submix unter 
Verwendung des Auxiliary-Eingangs als Effekt-
Return (beispielsweise Hall- oder Bus-Line-
Komprimierung)

• Einspielen von Audio von externen MIDI-
Instrumenten und anderen Audioquellen in den 
Mix, Abhören oder Routen von Audiospuren zur 
Aufnahme auf Festplatte (beispielsweise vom 
Audioausgang eines MIDI-Synthesizers)

• Zusammenfassen der Lautstärkeregelung eines 
beliebigen Submix unter einem einzigen Fader

• Mischen mehrerer Ausgänge eines 
Instrumenten-Plug-Ins

Routing auf einen Auxiliary-
Eingang

So nehmen Sie das Routing auf einen Auxiliary-
Eingang vor:

1 Klicken Sie auf den Input Path-Selektor des 
Auxiliary-Eingangs und wählen Sie einen 
Eingangs- oder Buspfad.

2 Klicken Sie auf den Output Path-Selektor des 
Auxiliary-Eingangs und wählen Sie einen 
Ausgangs- oder Buspfad. 

3 Passen Sie den Auxiliary-Eingangs-Fader zum 
Einstellen der Return-Lautstärke an. 

Master-Fader-Spuren und 
Signalfluss
Master-Fader-Spuren regeln die Master-
Ausgangspegel der Ausgangs- und Buspfade. 
Wenn Master-Fader einem aktivierten Ausgangs- 
oder Buspfad zugewiesen wurden, dienen sie zur 
Post-Fader-Effektverarbeitung und Master-
Pegelsteuerung für die Hauptmischung, 
Kopfhörer- und Cue-Mischungen, Stems, Effekt-
Sends und andere Signal-Routing-Anwendungen. 
Master-Fader unterstützen alle Spurformate auf 
Ihrem Pro Tools-System.

Siehe Submix-Beispiele unter „Signal-
Routing zum Abhören und Erstellen von 
Submixes“ auf Seite 1014.

Signalfluss des Audiosignals, Master-Fader-Spur

 

 

 

Input (Source) wird durch die 
Zuweisung von Output 
(anderer Spuren) festgelegtVolume

Inserts, 
Post-Fader 
(Plug-Ins oder 

Hardware)

Output Main-
Ausgang 

+ zusätzliche 
Ausgänge 
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Master-Fader nehmen die Audioverarbeitungskapazität 
Ihres Systems nicht in Anspruch. Sie haben bis 
zu fünf Post-Fader-Inserts und keine Sends. 
Außerdem verfügen Master-Fader-Spuren über keine 
Panoramaregler oder Mute- und Solo-Schaltflächen.

Im Gegensatz zu Inserts auf Audiospuren und 
Auxiliary-Eingängen sind Master-Fader-Inserts 
stets Post-Fader. Dadurch können Sie ein Dither-
Plug-In oder ein ähnliches Plug-In in Ihre Master-
Mischung einschleifen und deren Verarbeitung mit 
dem Master-Fader-Pegel anpassen. Weitere 
Informationen dazu finden Sie unter „Dither“ auf 
Seite 1032. 

Master-Fader-Pegelanzeigen

Pegelanzeigen auf Master-Fadern geben stets Post-
Fader-Pegel an, unabhängig von der Einstellung 
der Pre-Fader-Pegelanzeige im Options-Menü. 

Master-Fader und Pfade

Master-Fader können, wie im I/O-Setup definiert, 
Haupt- oder Nebenpfaden zugewiesen werden. Es 
können nicht mehrere Master-Fader demselben 
Pfad zugewiesen werden.

Aktive und inaktive Master-Fader

Wenn eine Master-Fader-Spur inaktiv ist, werden 
die mit ihr verknüpften Plug-Ins, I/O-
Zuweisungen und deren Ressourcen deaktiviert. 

Wenn eine Master-Fader-Ausgangszuweisung 
(Pfadzuweisung) deaktiviert wurde, regelt der 
Master-Fader die Master-Verstärkung dieses Pfads 
nicht mehr.

Wenn Sie eine Master-Fader-Spur duplizieren, ist 
die Zuweisung der duplizierten Spur inaktiv.

Verwendungszwecke für 
Master-Fader
Master-Fader bieten folgende 
Nutzungsmöglichkeiten:

• Steuerung und Verarbeitung von 
Ausgangsmischungen

• Abhören und Anzeige der Pegel eines 
Ausgangs (etwa Bus- oder Hardware-Ausgang), 
um Übersteuerung (Clipping) zu verhindern

• Steuerung der Submix-Pegel

• Pegelsteuerung für Effekt-Sends

• Pegelsteuerung für Submaster (über Busse 
geleitete Spuren) 

• Anwendung von Dithering oder anderen Inserts 
auf eine komplette Mischung

Mit Master-Fadern können Sie Submix-Pegel, 
Master-Send-Pegel und andere Ausgänge steuern. 
Sie können zwischen Ausgängen von Audio-
Interfaces und internen Bussen wählen. Sie können 
eine einem Ausgangspfad zugewiesene Master-
Fader-Spur als Master-Lautstärkeregelung 
verwenden: Sie können auch die einem Bus 
zugewiesene Master-Fader-Spur verwenden, 
um die Eingänge an Auxiliary-Eingangs-Spuren 
für Submixe zur Vermeidung von Übersteuerungen 
zu trimmen.

Wenn unbedingt ein Pre-Fader-Insert auf 
dem Master-Fader-Signal benötigt wird, 
richten Sie vor dem Master-Fader einen 
Auxiliary-Eingang ein. Beispiel: Wenn Sie 
die Mischung komprimieren, aber dafür auch 
einen Fade-Out erzeugen möchten, schleifen 
Sie ein Compression-Plug-In auf die 
Auxiliary-Eingangs-Spur und ein Dither-
Plug-In auf die Master-Fader-Spur ein, die 
dem Ausgangspfad der Auxiliary-Eingangs-
Spur zugewiesen ist. Anschließend können 
Sie mit dem Master-Fader ein Fade-Out 
erzeugen, ohne den 
Kompressionsschwellenwert der Mischung 
zu ändern.
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Verwendungszwecke für 
Master-Fader

So verwenden Sie den Master-Fader zur Master-
Lautstärkeregelung im Stereoformat:

1 Erstellen Sie eine Stereo-Master-Fader-Spur.

2 Legen Sie die Ausgänge aller Audiospuren der 
Session auf den Hauptausgangspfad (etwa 
Ausgänge 1 bis 2 des primären Audio-Interface) 
und legen Sie die Panoramaregelung für die 
einzelnen Spuren fest.

3 Legen Sie den Ausgang des Master-Faders auf 
den Hauptausgangspfad. 

So verwenden Sie den Master-Fader zum Trimmen 
des Eingangs eines Submix:

1 Erstellen Sie eine Auxiliary-Eingangs-Spur.

2 Leiten Sie das Signal von Audiospuren in Ihrer 
Session an den Eingang der Auxiliary-
Eingangs-Spur.

3 Erstellen Sie eine Master-Fader-Spur im 
Stereoformat und weisen Sie den Ausgang dem 
Buspfad zu, der die Auxiliary-Eingangs-Spur 
versorgt.

Instrumentenspuren und 
Signalfluss
Instrumentenspuren bieten dieselben Audiosignal-
Routingoptionen wie Auxiliary-Eingangs-Spuren, 
nur muss ihr Eingang von einem Instrumenten-
Plug-In stammen, das in die Instrumentenspur 
eingefügt wurde, oder von einem Bus- bzw.- 
Hardware-Eingang.

Instrumentenspuren werden als Eingänge für 
Instrumenten-Plug-Ins und andere Quellen 
(einschließlich interner Busse) verwendet. Sie 
lassen sich vollständig automatisieren. Wenn 
Sie eine Instrumentenspur als Eingang für eine 
externe Quelle verwenden, passen Sie den 
Ausgangspegel an der Quelle an, um den richtigen 
Aufnahmepegel zu erzielen. 

Signalfluss des Audiosignals, Instrumentenspur

Volume 

 

Instrumenten-Plug-In, 
interner Bus oder 
Hardware-Instrument

Input

Inserts 
(Plug-Ins 
oder 
Hardware-

Aufnahme 
(nur MIDI)

Solo/Mute

Sends, Pre-Fader

Sends, Post-Fader

Panner

Output
Main-
Ausgang 

+ zusätzliche 
Ausgänge 



Kapitel 43: Einfaches Mixen 985

Verwendungszwecke für 
Instrumentenspuren
Bei der Wiedergabe von MIDI von einer oder über 
eine Instrumentenspur können Sie Audio von 
folgenden Quellen steuern und abhören:

• Instrumenten-Plug-Ins, wie beispielsweise 
Software-Synthesizer oder -Sampler.

• Externe MIDI-Instrumente, wie Synthesizer und 
Sampler

Routing mit einer 
Instrumentenspur

So routen Sie Audio von einem externen MIDI-
Instrument zur Instrumentenspur:

1 Klicken Sie auf den Input Path-Selektor der 
Instrumentenspur und wählen Sie den 
entsprechenden Hardware-Eingang für das 
externe MIDI-Instrument.

2 Klicken Sie auf den Output Path-Selektor der 
Instrumentenspur und wählen Sie einen 
Ausgangs- oder Buspfad. 

3 Klicken Sie im Instruments-Bedienfeld auf den 
MIDI Input-Selektor und weisen Sie ein Gerät 
und einen Kanal aus dem Popup-Menü zur 
Aufnahme und Steuerung des externen MIDI-
Instruments zu.

4 Klicken Sie im Instruments-Bedienfeld auf den 
MIDI Output-Selektor und weisen Sie einen 
Anschluss und einen Kanal aus dem Popup-
Menü für das externe MIDI-Instrument zu.

5 Passen Sie den Instrumenten-Fader an, um die 
Lautstärke einzustellen.

VCA Master-Spuren 
(Nur Pro Tools HD)

VCA Master-Spuren emulieren den Betrieb von 
spannungsgesteuerten Verstärkerkanälen auf 
analogen Mischpulten, wo ein VCA-Kanal-Fader 
eingesetzt würde, um die Signalpegel anderer 
Kanäle auf dem Mischpult zu steuern, 
zu gruppieren oder auszugleichen.

VCA Master-Spuren leiten keine Audiosignale 
weiter und verfügen demnach nicht über Eingänge, 
Ausgänge, Inserts oder Sends. Einer VCA Master-
Spur wird eine Mix-Gruppe zugewiesen, die 
im Group Assignment-Selektor der VCA-Spur 
angezeigt wird. Die Einstellungen der Spuren in 
dieser Mix-Gruppe, die sogenannten Slave-
Spuren, werden durch die Einstellungen im VCA 
Master geändert. 

Weitere Informationen zur Zuweisung von 
MIDI-Eingängen und -Ausgängen für 
Instrumentenspuren finden Sie unter 
„Zuweisen von MIDI-Eingängen und -
Ausgängen für Instrumentenspuren“ auf 
Seite 245.

Weitere Informationen zum Einschleifen von 
Plug-Ins auf Spuren finden Sie unter 
„Einschleifen von Plug-Ins auf Spuren“ auf 
Seite 1042.
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Anzeigen der VCA Slave-Spur-
Einstellungen
Im Gegensatz zu VCAs auf herkömmlichen 
analogen Mischpulten wirken sich VCA Master-
Spuren in Pro Tools direkt auf ihre Slave-Spuren 
aus, sodass jede Slave-Spur immer die 
tatsächlichen Werte anzeigt: 

• Der Ausgangspegel jeder Slave-Spur wird durch 
die Position seines Faders angezeigt. 

• Der Solo-, Mute-, Record Enable- und 
TrackInput-Status jeder Slave-Spur wird durch 
die entsprechenden Einstellungen auf der Spur 
angezeigt.

Dadurch wird sichergestellt, dass der echte Status 
von Slave-Spuren stets richtig angezeigt wird, 
auch wenn eine VCA Master-Spur nicht sichtbar 
ist. 

VCA Slave-Spur-Einstellungen 
und -Gruppenverhalten
Wenn eine Gruppe einem VCA Master 
zugewiesen wird, folgen die VCA-veränderbaren 
Einstellungen (Lautstärke, Mute, Solo, Record 
Enable und TrackInput) auf den zugehörigen 
Slave-Spuren standardmäßig nicht automatisch 
dem Gruppenverhalten, das möglicherweise auf 
der Attributes-Seite des Groups-Dialogfelds 
eingerichtet ist. Dadurch können Sie die 
Ausgangspegel der Spuren in der Gruppe steuern 
und sind gleichzeitig weiterhin in der Lage, 
Spurpegel einzelner Gruppenmitglieder 
anzupassen. 

Es kann festgelegt werden, dass Slave-Spuren 
dem normalen Gruppenverhalten folgen. Siehe 
„Zuweisen von Gruppen zu VCA Mastern“ auf 
Seite 988.

Verwendungszwecke für VCA 
Master-Spuren
Durch Gruppieren von Spuren in einer Mix-
Gruppe und Zuweisen dieser Gruppe zu einer 
VCA Master-Spur haben Sie folgende 
Möglichkeiten:

• Steuern der Ausgangspegel aller Spuren des 
VCA-Gruppenmitglieds, ohne sie auf eine 
Auxiliary-Eingangs-Spur oder denselben 
Ausgangspfad zu leiten

• Erstellen mehrerer verschachtelter VCA-
Gruppen und gleichzeitiges Steuern der 
Ausgangspegel mehrerer Submixe

• Automatisieren eines Submixes durch 
Automatisieren der zugehörigen VCA Master-
Spur

VCA Master-Spur

 

Pegelanzeige

Group Assignment-
Selektor

TrackInput

Solo

Aufnahme

Stummschaltung

Anzeige des VCA-Spurtyps

Volume
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Steuerelemente für VCA Master-
Spuren
Die Steuerelemente auf einer VCA-Master-
Spur bestimmen die Einstellungen der 
entsprechenden Steuerelemente auf den Slave-
Spuren in der zugewiesenen Mix-Gruppe. VCA 
Master-Spuren verfügen über folgende 
Steuerelemente:

Volume

Der VCA-Lautstärke-Fader steuert den 
Lautstärke-Fader auf Audio-, Auxiliary-Eingangs-, 
Instrumenten-, Master-Fader- und anderen VCA 
Master-Spuren in einer VCA-gesteuerten Gruppe. 
(Lautstärke-Fader auf MIDI-Spuren werden nicht 
beeinflusst.) Lautstärke-Fader auf Slave-Spuren 
werden verschoben und zeigen den 
zusammengesetzten Pegel an, bzw. den Pegel auf 
jeder Spur, der auf die Position des VCA Master-
Lautstärke-Faders zurückzuführen ist. 

Stummschaltung

Die VCA Mute-Schaltfläche steuert den Mute-
Status auf Audio-, Auxiliary-Eingangs-, 
Instrumenten-, MIDI- und anderen VCA Master-
Spuren in einer VCA-gesteuerten Gruppe. Durch 
Stummschaltung einer VCA-gesteuerten Gruppe 
ändert sich der zugrunde liegende Mute-Status von 
Slave-Spuren nicht. (Mute-Schaltflächen auf 
Slave-Spuren, die bisher stummgeschaltet waren, 
weisen eine implizite Stummschaltung auf.) 

Solo

Die VCA Solo-Schaltfläche steuert den Solo-
Status auf Audio-, Auxiliary-Eingangs-, 
Instrumenten-, MIDI- und anderen VCA Master-
Spuren in einer VCA-gesteuerten Gruppe.

• Durch Soloschaltung eines VCA-Masters 
werden implizit alle Slave-Spuren 
stummgeschaltet, was indirekt einer 
Soloschaltung der Slave-Spuren entspricht.

• Durch Soloschaltung eines VCA Masters 
werden explizite Solos auf den zugehörigen 
Slave-Spuren entfernt – wodurch sie indirekt 
sologeschaltet werden – und alle anderen 
Spuren implizit stummgeschaltet.

• Wenn man eine Slave-Spur explizit soloschaltet, 
während die zugehörige VCA Master-Spur 
sologeschaltet ist, hebt dies die VCA Master-
Soloschaltung auf.

Record Enable

Mit der VCA Record Enable-Schaltfläche wird 
der Record Enable-Status ausschließlich der 
Audio-, Instrumenten- und anderen VCA-Spuren 
umgeschaltet, die bereits einzeln scharfgeschaltet 
wurden. Sie können dann die Scharfschaltung für 
diese Spuren mit der VCA Master Record Enable-
Funktion umschalten. 

So zwingen Sie vorübergehend alle Slave-Spuren 
dazu, ihren Scharfschaltungsstatus 
umzuschalten:

 Klicken Sie bei gedrückter Wahltaste (Mac) 
bzw. Alt-Taste (Windows) auf die Record 
Enable-Schaltfläche im VCA Master.

TrackInput

Mit der VCA TrackInput-Schaltfläche schalten Sie 
den Input Monitoring-Status nur der Audiospuren 
in einer VCA-gesteuerten Gruppe um, die 
scharfgeschaltet sind. Sie können den Input 
Monitor-Status für diese Spuren mit der VCA 
Master TrackInput-Schaltfläche umschalten. 

So zwingen Sie vorübergehend alle Slave-Spuren 
dazu, ihren Input Monitoring-Status 
umzuschalten:

 Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf die VCA Master 
TrackInput-Schaltfläche im VCA Master. 
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Pegelanzeige

Auf VCA Master-Spuren geben Pegelanzeigen 
den höchsten auf einer der einzelnen Spuren 
vorkommenden Pegel an und nicht einen 
Summenpegel aller Slave-Spuren. 

Das Kanalformat von Pegelanzeigen auf dem 
VCA Master wird wie folgt den Kanalformaten 
seiner Slave-Spuren entsprechend eingestellt:

• Wenn alle Slave-Spuren dasselbe Kanalformat 
aufweisen (Mono, Stereo oder ein Mehrkanal-
Format), stimmt die Anzahl der Pegelanzeigen 
auf der VCA Master-Spur mit der der Slave-
Spuren überein.

• Weichen die Formate der Slave-Spuren 
voneinander ab, wird die Anzahl der 
Pegelanzeigen auf der VCA Master-Spur auf 
Eins gesetzt.

Scharfschaltung, TrackInput 
und Slave-Spuren
Wenn eine Slave-Spur scharfgeschaltet ist (die 
Record Enable-Schaltfläche leuchtet) oder auf 
Input Only-Modus gesetzt ist (die TrackInput-
Schaltfläche leuchtet), wird die Automation 
vorübergehend ausgeschaltet, und ihr Lautstärke-
Fader wird nicht mehr vom VCA Master 
beeinflusst.

Zuweisen von Gruppen zu VCA 
Mastern
Eine vorhandene Mix-Gruppe kann einem VCA 
Master zugewiesen werden. Auch eine neue Mix-
Gruppe kann einem VCA Master zugewiesen 
werden, während sie erstellt wird. Einem VCA 
Master kann jeweils nur eine Gruppe zugewiesen 
werden. Ein VCA Master kann keine Gruppe 
steuern, die sich selbst enthält.

So weisen Sie einem VCA Master eine vorhandene 
Gruppe zu:

 Klicken Sie auf den Group Assignment-Selektor 
auf der VCA Master-Spur und wählen Sie eine 
verfügbare Gruppe aus dem Popup-Menü.

So weisen Sie einem VCA Master eine neue 
Gruppe zu:

1 Wählen Sie bei der Erstellung einer neuen Gruppe 
„Mix“ oder „Mix/Edit“ als Gruppentyp aus.

2 Wählen Sie im Group-Dialogfeld eine 
verfügbare VCA Master-Spur aus dem VCA-
Popup-Menü. 

Spurmitgliedschaft in mehreren VCA-Gruppen

Es ist möglich, dass eine einzelne Slave-Spur 
Mitglied mehrerer VCA-gesteuerter Gruppen ist. 
In diesem Fall wird der Anteil aller VCA Master-
Lautstärke-Fader auf der Slave-Spur 
zusammengefasst. Mute, Solo, Record Enable und 
TrackInput folgen denselben Regeln für die 
Aktivierung oder Deaktivierung von Slave-
Spuren. 

Zulassen des 
Gruppenverhaltens von VCA 
Slave-Spur-Steuerelementen
Wenn es sich bei einer Spur um eine VCA-Slave-
Spur handelt, folgen ihre Lautstärke-, Mute-, Solo-, 
Record Enable- und TrackInput-Steuerelemente 
den VCA-Funktionen und normalerweise nicht 
dem Verhalten von Mix-Gruppen. 

Zuweisen einer vorhandenen Gruppe zu einem VCA 
Master
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Diese Slave-Spur-Steuerelemente können jedoch 
so eingestellt werden, dass sie das Verhalten von 
Mix-Gruppen zusätzlich zu ihren VCA-
Funktionen zulassen.

So lassen Sie Gruppenverhalten von VCA-
bezogenen Steuerelementen auf Slave-Spuren zu:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing. 

2 Deaktivieren Sie im Automation-Abschnitt die 
Option Standard VCA Logic for Group 

Attributes. 

3 Klicken Sie auf OK.

Lautstärke, Mute, Solo, Record Enable und 
TrackInput werden als Mix-Gruppen-Attribute im 
Group-Dialogfeld verfügbar. 

Inserts
In Pro Tools können Sie auf jede Audio-, 
Auxiliary-Eingangs-, Master-Fader- oder 
Instrumentenspur bis zu zehn Inserts (A–E und 
F–J) einschleifen. Ein Insert kann entweder ein 
Software-Plug-In-Insert, ein Hardware-Insert 
oder ein Instrumenten-Plug-In sein (siehe 
Kapitel 44: „Plug-In- und Hardware-Inserts“). 

Inserts bieten folgende Funktionen: 

• Plug-Ins und Hardware-Inserts routen das 
Signal von der Spur durch den Effekt Ihrer Wahl 
und führen es automatisch auf dieselbe Spur 
zurück. 

• Hardware-Inserts senden das Signal an die 
entsprechenden Eingangs- und Ausgangskanäle 
eines Audio-Interface (an das Sie externe 
Effektgeräte anschließen können) und von dort 
zurück.

• Einige Instrumenten-Plug-Ins akzeptieren 
Audio vom Spureingang, sodass Sie sie als 
Bearbeitungs-Plug-Ins verwenden können.

• Inserts auf Audio-, Auxiliary-Eingangs- und 
Instrumentenspuren sind Pre-Fader. 

• Inserts auf Master-Fadern sind Post-Fader.

• Inserts können umgangen (auf Bypass 
geschaltet) oder deaktiviert werden.

• Die meisten Plug-In-Steuerelemente lassen sich 
vollständig automatisieren.

Ausgangsformat von Spuren und 
Plug-Ins
Pro Tools unterstützt Mono-, Multimono-, Stereo- 
und Mehrkanal-Plug-Ins (nur Pro Tools HD mit 
Surround Mixer). 

Da Inserts in Serie bearbeitet werden, kann durch 
Ändern des Plug-In-Formats auch 
das Kanalformat verändert werden. Wenn Sie 
beispielsweise ein Plug-In zum Generieren von 
Stereo- aus Monosignalen auf einen Mono-
Auxiliary-Eingang einschleifen, ändert sich der 
Signalpfad ab diesem Plug-In auf der ganzen 
übrigen Spur. Das bedeutet, dass alle Hardware-
Inserts oder Plug-Ins nach dem Stereo-Plug-In 
entweder Stereo In/Stereo-Out-Plug-Ins oder 
unterstützte Mehrkanal-Plug-Ins sein müssen. 

Plug-In-Formate
Pro Tools unterstützt Mono- und Stereo-Plug-Ins, 
einschließlich der drei folgenden Plug-In-Pfade: 

• Mono In/Mono Out

• Mono In/Stereo Out

• Stereo In/Stereo Out

Pro Tools HD-Sessions mit einem Surround-
Mixer unterstützen 3- bis 8-Kanal-, Multimono- 
und Mehrkanal-Plug-Ins.
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Konfigurieren des Inserts-
Bedienfelds im Mix- und Edit-
Fenster
Audiospuren, Auxiliary-Eingänge, Master-Spuren 
und Instrumentenspuren enthalten zwei 
verschiedene Inserts-Bedienfelder: Inserts A–E 
(Inserts 1–5) und Inserts F–J (Inserts 6–10). 
Das View-Menü bietet spezielle Optionen für die 
Anzeige der verschiedenen Inserts im Mix- und 
Edit-Fenster.

So zeigen Sie Inserts im Mix-Fenster an:

 Wählen Sie eine der folgenden Optionen:

• View > Mix Window > Inserts A–E 

• View > Mix Window > Inserts F–J 

So zeigen Sie Inserts im Edit-Fenster an:

 Wählen Sie eine der folgenden Optionen:

• View > Edit Window > Inserts A–E 

• View > Edit Window > Inserts F–J 

HEAT
(Nur Pro Tools|HDX-Systeme mit HEAT-Option)

HEAT (Harmonically Enhanced Algorithm 
Technology) ist eine Softwareoption, 
die Pro Tools|HDX-Systemen ein „analoges 
Feeling“ verleiht. HEAT wird auf alle aktiven 
Audiospuren in Ihrer Session angewendet. 
Dadurch wird der Effekt eines analogen 
Mischpults emuliert. Mithilfe von HEAT können 
Sie Ihren Mischungen eine warme, analog 
modellierte Verzerrung mit weicher Sättigung 
hinzufügen. Durch Verwendung von HEAT mit 
der Stereo Pan Depth-Option (im Session Setup-
Fenster) können Sie den Effekt klassischer 
Analogmischpulte direkt in Pro Tools emulieren.

Stereo Pan Depth
In Pro Tools können Sie die Pan-Tiefe für 
Stereoausgangspfade auswählen. Sie können die 
Pan-Tiefe im Session Setup-Fenster festlegen. 
Mithilfe der Pan Depth-Einstellung können Sie die 
Signaldämpfung festlegen, wenn eine Spur auf 
einen Stereoausgang geleitet und zentral gepannt 
wird.

So legen Sie die Stereo-Pan-Tiefe fest:

1 Wählen Sie Setup > Session, um das Session 
Setup-Fenster zu öffnen.

2 Wählen Sie über den Pan Depth-Selektor eine 
Option.

Weitere Informationen finden Sie unter 
Kapitel 42: „HEAT“.

Der Surround Mixer benötigt etwas mehr 
DSP-Ressourcen als der Stereo Mixer. 
Deshalb sollten Sie das Stereo Mixer-Plug-In 
verwenden, wenn Sie regelmäßig in Stereo 
und mit einer Pan-Tiefe von –2,5 dB mischen 
möchten. 

Session-Setup-Fenster
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Stereo Pan Depth-Optionen
Die folgenden Pan Depth-Optionen stehen zur 
Verfügung:

–2,5 dB – ist die Standardeinstellung für die 
Stereo-Pan-Tiefe in Pro Tools 8.0.x und niedriger. 
Wenn Sie eine Session aus Pro Tools 8.0.x oder 
niedriger in Pro Tools 8.1 oder höher öffnen, ist 
dies die Standardeinstellung.

–3,0 dB – Industriestandard-gemäße Pan-Tiefe für 
Surround-Mixer und viele Mischpulte. Dies ist die 
Standardeinstellung für neue Sessions in Pro Tools 
8.1 und höher.

–4,5 dB – standardmäßige Pan-Tiefe für viele 
analoge Mischpulte im britischen Stil.

–6,0 dB – standardmäßige Pan-Tiefe für volle 
Mono-Kompatibilität.

Bedienfelder im Mix- und 
Edit-Fenster
Die Mix- und Edit-Fenster können mithilfe von 
Menübefehlen oder Selektoren für die Anzeige 
von Bedienfeldern so konfiguriert werden, dass 
verschiedene Mixing-Steuerelemente ein- oder 
ausgeblendet werden. 

Die meisten der Bedienfelder sind in beiden 
Fenstern verfügbar, wenn nicht anders angegeben.

Window View-Selektoren
Für das Edit-Fenster und das Mix-Fenster steht 
jeweils ein Window View-Selektor zur Anpassung 
der Fensteransicht zur Verfügung.

Bei Formaten, die über Stereo hinausgehen 
(beispielsweise 5.1) wird das gesamte 
Surround-Ausgangs-Panning auf –3,0 dB 
festgelegt. Die Optionen für die variablen 
Pan-Tiefen stehen nur für Stereoausgänge 
zur Verfügung:

Edit-Fenster-Ansicht-Selektor

Ansichts-Selektor des Mix-Fensters
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Anzeigen von Bedienfeldern

Führen Sie einen der folgenden Schritte aus, 
um alle Bedienfelder im Mix- oder Edit-Fenster 
anzuzeigen:

 Wählen Sie View > Mix Window (oder Edit 

Window) > All.

 Klicken Sie auf den Mix Window View-
Selektor (oder Edit Window View-Selektor) 
und wählen Sie All.

Führen Sie einen der folgenden Schritte aus, 
um keins der Bedienfelder im Mix- oder Edit-
Fenster anzuzeigen:

 Wählen Sie View > Mix Window (oder Edit 

Window) > None.

 Klicken Sie auf den Mix Window View-
Selektor (oder Edit Window View-Selektor) 
und wählen Sie None.

So blenden Sie die verfügbaren Bedienfelder 
in den Mix- und Edit-Fenstern ein bzw. aus:

 Wählen Sie View > Mix Window (oder Edit 

Window) und aktivieren oder deaktivieren Sie 
einen der Bedienfeldtypen (etwa Comments).

 Klicken Sie auf den Mix Window View-
Selektor (oder Edit Window View-Selektor) 
und aktivieren oder deaktivieren Sie einen der 
Bedienfeldtypen (etwa Comments).

Ausblenden von Bedienfeldern 
im Edit-Fenster
Sie können Bedienfeldspalten im Edit-Fenster auf 
schnelle Weise mithilfe der Maus und einer 
zusätzlichen Tastenkombination ausblenden. 

So blenden Sie eine Bedienfeldspalte im Edit-
Fenster aus:

 Klicken Sie bei gedrückter Alt- (Windows) bzw. 
Wahltaste (Mac) auf die auszublendende Spalte 
(„Mic Pre“, „Comments“, „Instrument“, „Inserts 
A–E“, „Inserts F–J“, „Sends A–E“, „Sends F–J“, 
„I/O“, „Real-Time Properties“ oder „Track 
Color“).

Window View-Optionen
Comments-Bedienfeld – zeigt alle im Track 
Name/Comments-Dialogfeld eingegebenen 
Anmerkungen an. Weitere Informationen finden 
Sie unter „Benennen von Spuren“ auf Seite 222.

Mic Preamps-Bedienfeld – zeigt Spurregler für 
den PRE an. Ausführliche Informationen erhalten 
Sie im PRE-Handbuch.

Comments-Bedienfeld im Mix- und Edit-Fenster

Mic Preamps-Bedienfeld
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Instruments-Bedienfeld – zeigt MIDI-
Steuerelemente auf Instrumentenspuren (MIDI 
Input-Selektor, MIDI Output-Selektor, MIDI-
Lautstärke, MIDI-Pan und MIDI-Mute).

HEAT-Bedienfeld (nur Pro Tools|HDX-Systeme 
mit HEAT-Option, nur Mix-Fenster) – zeigt 
HEAT-Spur-Steuerelemente für Audiospuren im 
Mix-Fenster an. Dieses Bedienfeld steht nur im 
Mix-Fenster für Pro Tools|HDX-Systeme bei 
installierter und autorisierter HEAT-Option zur 
Verfügung. 

Inserts-Bedienfeld (Inserts A–E und Inserts F–J) 
– zeigt Inserts (Software-Plug-Ins und Hardware-
I/O-Inserts) für jede Spur an. Weitere 
Informationen finden Sie unter „Konfigurieren des 
Inserts-Bedienfelds im Mix- und Edit-Fenster“ auf 
Seite 990.

Sends-Bedienfeld (Sends A–E und Sends F–J) – 
dieses Bedienfeld zeigt Send-Zuweisungen für 
jede Spur an. Um diese auszublenden, deaktivieren 
Sie die Option. Weitere Informationen finden Sie 
unter „Konfigurieren des Sends-Bedienfelds im 
Mix- und Edit-Fenster“ auf Seite 1002.

Pegelanzeigen- und Faders-Bedienfeld (nur Mix-
Fenster) – zeigt Spurpegelanzeigen und Fader an. 
Das Ausblenden von Anzeigen und Fadern kann 
nützlich sein, um Platz auf dem Bildschirm 
zu schaffen, insbesondere wenn Sie mit einer 
Bedienoberfläche arbeiten.

Instruments-Bedienfeld

HEAT-Bedienfeld

Bedienfelder im Mix-Fenster

Pegelanzeigen- und Faders-Bedienfeld (Mix-Fenster)

Inserts (A–E)-Bedienfeld

Sends (A–E)-Bedienfeld

I/O-Bedienfeld

Sends (F–J)-Bedienfeld

Inserts (F–J)-Bedienfeld
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I/O-Bedienfeld (nur Edit-Fenster) – zeigt Input- 
und Output-Selektoren sowie Lautstärke- und 
Panorama-Anzeigen für jede Spur an.

Klicken Sie auf die Lautstärke- oder Panorama-
Anzeige im I/O-Bedienfeld des Edit-Fensters, um 
die Lautstärke- bzw. Panorama-Einstellungen mit 
einem Popup-Fader anzupassen.

Real-Time Properties-Bedienfeld (nur Edit-
Fenster) – zeigt Einstellungen für Echtzeit-
Eigenschaften für MIDI- und Instrumentenspuren 
an. Weitere Informationen zu Echtzeit-
Eigenschaften finden Sie unter „MIDI-Echtzeit-
Eigenschaften“ auf Seite 726.

Delay Compensation-Bedienfeld – im Delay 
Compensation-Bedienfeld werden die gesamte 
Plug-In-Verzögerung und Hardware-Insert-
Verzögerung auf jeder Spur und die Gesamtlänge 
der Verzögerung angezeigt, die Pro Tools auf jede 
Spur anwendet. In diesem Bedienfeld können 
Sie außerdem ein benutzerdefiniertes Offset für 
die Spurverzögerung anwenden. Das Delay 
Compensation-Bedienfeld kann im Mix-Fenster 
angezeigt werden.

Die Verzögerungswerte können je nach Auswahl 
auf der Operation Preferences-Registerkarte 
entweder in Samples oder in Millisekunden 
angegeben werden. Weitere Informationen zum 
Verzögerungsausgleich finden Sie unter 
„Verzögerungsausgleich“ auf Seite 1024.

Track Color-Bedienfeld – zeigt die Spurfarbe jeder 
Spur an. Weitere Informationen finden Sie unter 
„Farbliche Kennzeichnung von Spuren, Clips, 
Markern und Gruppen“ auf Seite 250.

I/O-Bedienfeld (Edit-Fenster)

I/O-Bedienfeld mit Lautstärke-Popup-Fader (Edit-
Fenster)

I/O-Bedienfeld mit Panorama-Popup-Regler (Edit-
Fenster)

Real-Time Properties-Bedienfeld (Edit-Fenster)

Delay Compensation-Bedienfeld

 

Verzögerungsanzeige

Benutzerdefiniertes Offset 

Anzeige für Spurausgleich
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Audioeingangs- und 
-ausgangspfade
In Pro Tools können Sie die physikalischen 
Eingänge und Ausgänge der Audio-Interfaces und 
internen Buspfade und -unterpfade im I/O Setup-
Dialogfeld und dem Hardware Setup-Dialogfeld 
konfigurieren. Diese Hardware-Eingänge und -
Ausgänge sowie die internen Buspfade können als 
Eingänge und Ausgänge der Audio-, Auxiliary-
Eingangs- und Instrumentenspuren sowie der 
Master-Fader zugewiesen werden.

Audio-Eingangspfad
Mithilfe der Input Path-Selektors wird die 
Eingangsquelle für Audio-, Auxiliary-Eingangs- 
und (optional) Instrumentenspuren festgelegt. 
Spureingänge können von Hardware-Eingängen 
oder internen Buspfaden und -unterpfaden 
festgelegt werden. Ausführliche Informationen 
zum Zuweisen von Spureingängen finden Sie 
unter „Zuweisen von Eingängen 
an Audioeingänge“ auf Seite 236.

Hardware-Eingangs- und Buspfade können im 
I/O Setup-Dialogfeld eingerichtet werden. 
Weitere Informationen finden Sie unter Kapitel 7: 
„I/O-Setup“.

Außerdem können Sie im Hardware Setup-
Dialogfeld festlegen, welche physikalischen Ports 
auf die Eingänge in Pro Tools geroutet werden 
sollen. Weitere Informationen finden Sie unter 
„Konfigurieren der Pro Tools-
Systemeinstellungen“ auf Seite 52.

Audio-Ausgangspfad
Im Output Path-Selektor für die Spur werden die 
Post-Fader-Signale auf die zugewiesenen 
Ausgangs- oder Buspfade geroutet. Der Output 
Path-Selektor routet den Hauptausgang der Spur 
auf den ausgewählten Haupt- oder Nebenpfad. 
Spuren können direkt auf Hardware-Ausgänge 
oder zum Erstellen eines Submixes auf interne 
Buspfade bzw. -nebenpfade geroutet werden. 

Das Spurformat (Mono, Stereo oder Mehrkanal) 
bestimmt, welche Haupt- und Nebenpfade für den 
Ausgang einer Spur zur Verfügung stehen. 
Ausführliche Informationen zum Zuweisen von 
Spurausgängen finden Sie unter „Zuweisen von 
Audioausgängen“ auf Seite 237.

Beim Erstellen von Audio-, Auxiliary-Eingangs-, 
Master-Fader- und Instrumentenspuren wird ein 
Format festgelegt: Mono, Stereo oder Mehrkanal 
(mehr Kanäle als Stereo).

• Monospuren können allen verfügbaren 
Mono-, Stereo- oder Mehrkanal-Haupt- und 
-Nebenpfaden zugewiesen werden.

• Stereospuren können allen verfügbaren 
Mono-, Stereo- oder Mehrkanal-Haupt- und 
-Nebenpfaden zugewiesen werden.

• Mehrkanalspuren (nur Pro Tools HD) können 
Monopfaden oder Pfaden mit derselben 
Kanalanzahl zugewiesen werden 
(beispielsweise eine LCRS-Spur einem Mono- 
oder LCRS-Pfad). 
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Output-Fenster
Die Output-Fenster bieten die wichtigsten 
Steuerelemente, die Sie zum Mischen einer 
Spur benötigen (etwa Panoramaregelung und 
Lautstärkeregelung für Spuren). So können Sie 
statt im Mix- bzw. Edit-Fenster auch in diesen 
Fenstern grundlegende Editiervorgänge 
durchführen. Output- und Send-Fenster mit 
mehreren Kanälen bieten zusätzlich erweiterte 
Panner-Anzeigen und weitere Surround-
spezifische Steuerelemente. Siehe Kapitel 49: 
„Pannen und Mischen im Surround-Format“. 

Output-Fenster eignen sich besonders für 
umfangreiche Sessions, um die Steuerelemente 
wichtiger Spuren im direkten Zugriff zu halten, 
unabhängig davon, wie Sie die Spuren im Mix- 
oder Edit-Fenster (oder auf einer 
Bedienoberfläche) anordnen. Siehe „Output-
Fenster für Spuren und Sends“ auf Seite 1009.

Mehrfache 
Ausgangszuweisungen
Pro Tools-Audio-, Auxiliary-Eingangs- und 
Instrumentenspuren können mehreren 
Ausgangspfaden zugewiesen werden. Durch 
das Zuweisen an mehrere Pfade kann dieselbe 
Mischung auf effiziente Weise auf getrennte 
Ausgänge geroutet werden. Dies ermöglicht 
die gleichzeitige Ausgabe an verschiedene 
Abhörlautsprecher und Kopfhörermischungen 
und ist nützlich in anderen Situationen, in denen 
eine parallele Mischung nötig ist.

So weisen Sie derselben Spur mehrere 
Ausgänge zu:

1 Weisen Sie einen Hauptausgangspfad zu, indem 
Sie ihn im Output Path-Selektor der jeweiligen 
Spur auswählen. 

2 Klicken Sie im Output Path-Selektor der Spur 
bei gedrückter Windows- (Windows) bzw. Ctrl-
Taste (Mac) auf einen weiteren Ausgangspfad. 
Das neu ausgewählte Ausgabeziel wird als 
zusätzlicher Ausgang hinzugefügt. 

Anzeige mehrfacher 
Ausgangszuweisungen
Wenn eine Spur mehreren Ausgangspfaden 
zugewiesen wurde, wird der Status („mehrfach 
zugewiesen“ bzw. „aktiv/inaktiv“) im Output 
Path-Selektor folgendermaßen angegeben:

• Ein Pluszeichen (+) kennzeichnet eine Spur mit 
mehrfachen Ausgangszuweisungen. 

• Im Output Path-Selektor sind alle momentan 
zugewiesenen Ausgänge mit einem Häkchen 
versehen, das anzeigt, dass sie für die aktuelle 
Spur aktiviert sind. 

• Ein Sternchen (*) zeigt an, dass ein oder mehrere 
momentan zugewiesene Ausgänge deaktiviert 
sind. 

Klicken Sie bei gedrückter Alt- und Windows-
Taste (Windows) bzw. Wahl- und Ctrl-Taste 
(Mac) auf die Ausgänge, um die Zuweisung 
allen Spuren hinzuzufügen, oder klicken Sie 
bei gedrückter Alt-, Umschalt- und Windows-
Taste (Windows) bzw. Wahl-, Umschalt- und 
Ctrl-Taste (Mac) auf die Ausgänge, um sie 
allen ausgewählten Spuren hinzuzufügen.

Kennzeichnung mehrfacher Ausgangszuweisungen

Anzeige mehrerer Ausgangszuweisungen mit 
mindestens einem inaktiven Ausgang
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Inaktive Ausgänge
Ein Ausgangspfad kann deaktiviert werden, indem 
Sie ihn entweder global im I/O Setup-Dialogfeld 
(für alle diesem Pfad zugewiesenen Spuren) oder 
lokal jeweils für eine Zuweisung (nur den Ausgang 
auf dieser Audio-, Auxiliary-Eingangs- oder 
Instrumentenspur) deaktivieren. 

Führen Sie zum Deaktivieren eines 
Ausgangspfads einen der folgenden Schritte 
durch:

 Klicken Sie mit gedrückter Befehls- und Ctrl-
Taste (Mac) bzw. Strg- und Windows-Taste 
(Windows) auf den Output-Selektor.

 Klicken Sie mit der rechten Maustaste auf den 
Output-Selektor und wählen Sie Make Inactive.

Beim Öffnen von Sessions werden Ausgänge 
automatisch deaktiviert, wenn die erforderliche 
Hardware oder andere Ressourcen nicht verfügbar 
sind. 

Alle mit inaktiven Ausgängen verknüpften 
Automations-Playlists bleiben erhalten. In der 
Session vorgenommene Edits wirken sich auch auf 
die Automations-Playlist des Ausgangs der 
inaktiven Spur aus.

Führen Sie zum Aktivieren eines Ausgangspfads 
einen der folgenden Schritte durch:

 Klicken Sie mit gedrückter Befehls- und Ctrl-
Taste (Mac) bzw. Strg- und Windows-Taste 
(Windows) auf den Output-Selektor.

 Klicken Sie mit der rechten Maustaste auf den 
Output-Selektor und wählen Sie Make Active.

Inaktive Ausgänge und DSP-
Ressourcen
Wenn Sie einen Ausgang einer Spur deaktivieren, 
wird er „stumm“, alle Automations- und 
Playlistdaten bleiben aber erhalten. Inaktive 
Ausgänge verbrauchen keine Ressourcen für 
HDX DSP-Mixer-Verbindungen, aber 
zugewiesene Plug-Ins auf der Spur nutzen 
weiterhin die von ihnen benötigten DSP-
Ressourcen. Für hostbasierte AAX-Plug-Ins 
werden CPU-Ressourcen benötigt. DSP-basierte 
AAX-Plug-Ins verwenden den auf 
Pro Tools|HDX-Karten verfügbaren DSP.

Sie können DSP-Ressourcen eines nicht genutzten 
Plug-Ins freigeben, indem Sie seine Spur 
deaktivieren oder nur das jeweilige Plug-In 
deaktivieren. 

No Output-Option
Spurausgänge können auf No Output gesetzt 
werden. Durch Zuweisen dieser No Output-Option 
geht eine der Spur gegebenenfalls zugewiesene 
automatische Panoramaregelung (Panning 
Automation) verloren.

Spuren mit der No Output-Option sind zwar nicht 
hörbar, geben aber trotzdem nicht die mit ihnen 
verknüpften DSP-Ressourcen frei. 

Siehe „Deaktivieren von Spuren“ auf 
Seite 249.

Weitere Informationen hierzu finden Sie 
unter „Aktive und inaktive Elemente“ auf 
Seite 17 und „Deaktivieren von Inserts“ auf 
Seite 1041.
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Sends
In Pro Tools können Sie auf jede Audio-, Auxiliary-
Eingangs-, Master-Fader- oder Instrumentenspur bis 
zu zehn Sends (A–E und F–J) einschleifen.

Sends bieten folgende Funktionen: 

• Sends werden entweder als Pre- oder Post-Fader 
eingesetzt.

• Auf Sends können Pegel angezeigt werden.

• Die Steuerelemente für Send-Pegel, Send-
Panoramaregelung, Send-Stummschaltung und 
LFE können so konfiguriert werden, dass sie 
sich nach Gruppen richten.

• Send-Pegel, Send-Stummschaltung und Send-
Panoramaregelung (für Stereo- und Mehrkanal-
Sends) lassen sich vollständig automatisieren. 
Siehe „Automatisieren von Sends“ auf 
Seite 1087.

• Send-Steuerelemente können sowohl im Mix- 
und Edit-Fenster als auch in ihren Output-
Fenstern angezeigt und bearbeitet werden.

• Sends können verfügbaren Ausgangs- und 
Buspfaden (Haupt- oder Nebenpfaden) 
zugewiesen werden und zwar in Mono, Stereo 
oder jedem unterstützten Mehrkanalformat für 
Surround-Mischungen. 

• Für jeden Send sind mehrere Zuweisungen 
möglich (etwa zu verfügbaren Ausgangs- und 
Buspfaden).

Sends müssen durch eine Auxiliary-Eingangs-, 
Audio- oder Instrumentenspur zur Mischung 
zurückgeführt werden, damit sie in Pro Tools 
angehört werden können. Die Sends können dann 
durch einen Auxiliary-Eingang (oder eine 
Instrumentenspur) abgehört und bearbeitet, auf 
Audiospuren aufgezeichnet und durch Bouncing 
auf Festplatte übertragen werden. (Bouncen 
und Mixdown werden unter Kapitel 46: 
„Mixdown“. erläutert.)

Zuweisen von Sends zu Spuren

So fügen Sie einer Spur einen Send hinzu:

1 Stellen Sie sicher, dass im Mix- oder Edit-
Fenster das Sends-Bedienfeld aktiviert ist. 
(Informationen hierzu finden Sie unter 
„Bedienfelder im Mix- und Edit-Fenster“ auf 
Seite 991.) 

2 Klicken Sie auf den Send-Selektor der Spur und 
wählen Sie einen Pfad aus dem Popup-Menü.

Zuweisen eines Sends an einen Stereo-Buspfad 
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Der Send kann im Mono- oder Stereo-Format 
(oder einem anderen unterstützten 
Mehrkanalformat für Surround-Mischungen) 
vorliegen und wird auf einen Ausgangs- oder 
Buspfad geroutet.

3 Führen Sie einen der folgenden Schritte aus, um 
den Ausgangspegel des Sends im Send-Fenster 
einzustellen:

• Anpassen des Send-Pegel-Faders

• Sie können den Pegel für den Send auf Null 
(0 dB) stellen, indem Sie bei gedrückter Alt- 
(Windows) bzw. Wahltaste (Mac) auf den Send-
Pegel-Fader klicken.

Wenn Sie einen neuen Send erstellen, richtet sich 
der anfängliche Ausgangspegel nach der 
ausgewählten Sends Default to –INF-
Voreinstellung.

Pans für Sends können durch Aktivieren der Send 

Pans Default To Follow Main Pan-Voreinstellung 
mit der Panoramaregelung auf dem 
Hauptausgangspfad der Spur verknüpft werden. 

So ändern Sie die Standardeinstellung für Sends:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Sends Default to „–INF“.

• Wenn Sie Sends Default to „–INF“ deaktivieren, 
wird der Pegel von neuen Sends automatisch auf 
Null (0 dB) gesetzt.

3 Sie haben folgende Möglichkeiten:

• Wählen Sie Send Pans Default to Follow 

Main Pan.

• Deaktivieren Sie Send Pans Default to Follow 

Main Pan, damit die Panoramasteuerung über 
die Sends unabhängig von der 
Panoramaregelung auf dem Hauptausgangspfad 
der Spur erfolgt.

So entfernen Sie einen Send aus einer Spur:

 Klicken Sie auf die Sends-Schaltfläche der Spur 
und wählen Sie im Popup-Menü No Send. Send-Fenster (Stereo)
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Stummschalten von Sends
In Pro Tools können Sie Sends entweder 
individuell stummschalten oder für alle 
ausgewählten Spuren Ihrer Session bzw. die Sends 
A-E oder F-J für ausgewählte Spuren.

So aktivieren oder deaktivieren Sie die 
Stummschaltung eines Sends im Send- oder Mix-
Fenster in der erweiterten Send-Anzeige:

 Klicken Sie auf die Mute-Schaltfläche für den 
Send.

So aktivieren bzw. deaktivieren Sie die 
Stummschaltung im Track-Menü:

1 Wählen Sie die Spuren, für die Sie Sends 
stummschalten möchten. Klicken Sie bei 
gedrückter Wahltaste (Mac) oder Alt-Taste 
(Windows) auf alle für die Session angezeigten 
Spuren.

2 Wählen Sie eine der folgenden Optionen:

 Track > Mute Sends > All

 Track > Mute Sends > A–E

 Track > Mute Sends > F–J

Tastaturbefehle zum Stummschalten 
von Sends

Pro Tools bietet Tastaturbefehle zum 
Stummschalten von Sends im Mix-Fenster:

 Klicken Sie bei gedrückter Befehlstaste (Mac) 
bzw. Starttaste (Windows) im Mix- oder Edit-
Fenster auf eine „Send Assignment“-Schaltfläche, 
um diesen und alle nachfolgenden Sends für eine 
Spur stummzuschalten.

 Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) bzw. Starttaste (Windows) im 
Mix- oder Edit-Fenster auf eine Send Assignment-
Schaltfläche, um diesen und alle nachfolgenden 
Sends für eine Spur stummzuschalten. So können 
Sie alle Sends Ihrer Session mit einem Klick 
stummschalten.

 Drücken Sie Umschalt + Q zum Stummschalten 
(bzw. Aufheben der Stummschaltung) aller Sends 
von ausgewählten Spuren.

 Drücken Sie Umschalt + 3 zum Stummschalten 
(bzw. Aufheben der Stummschaltung) der Sends 
A-E von ausgewählten Spuren.

 Drücken Sie Umschalt + 4 zum Stummschalten 
(bzw. Aufheben der Stummschaltung) der Sends 
F-J von ausgewählten Spuren.

Erstellen und Zuweisen einer 
neuen Spur aus einem Send
In Pro Tools können Sie eine neue Auxiliary-
Eingangs-, Audio- oder Instrumentenspur im 
Send-Selektor erstellen und den Send über einen 
verfügbaren internen Mix-Bus automatisch dem 
Eingang der neuen Spur zuweisen.

So erstellen Sie eine neue Spur aus einem Send:

1 Klicken Sie in einer bestehenden Spur auf den 
Send-Selektor und wählen Sie New Track.

2 Wählen Sie im New Track-Dialogfeld die 
Optionen Width, Type und Time Base für die 
neue Spur.

3 Geben Sie einen Namen für die neue Spur ein.

Der eingegebene Name wird für die neue Spur und 
den neuen Mix-Bus verwendet. (Beispiel: Wenn 
Sie den Namen „Drum Sub“ eingegeben haben, 
erstellt Pro Tools eine neue Auxiliary-Eingangs-
Spur namens „Drum Sub“ und ebenso einen 
internen Mix-Bus namens „Drum Sub“.)

New Track-Dialogfeld



Kapitel 43: Einfaches Mixen 1001

4 Aktivieren (oder deaktivieren) Sie diese 
Option, je nachdem, ob die neue Spur neben der 
aktuellen Spur (mit dem Send) erstellt werden 
soll.

5 Klicken Sie auf OK.

Pro Tools erstellt eine neue Spur, wobei der 
Ausgang des anfänglichen Send über einen 
verfügbaren internen Mix-Bus automatisch zum 
Eingang der neuen Spur geroutet wird. 

Zuweisen einer bestehenden 
Spur aus einem Send
In Pro Tools können Sie über einen verfügbaren 
Mix-Bus einen Send direkt einer aktiven 
Auxiliary-Eingangs-, Audio- oder 
Instrumentenspur zuweisen. Hinweis: Damit die 
Zuweisung für die Zielspur zur Verfügung steht, 
muss sie entweder auf einen internen Mix-Bus 
oder auf No Input festgelegt werden.

So weisen Sie einem verfügbaren Eingang auf 
einer bestehenden Spur einen Send zu:

1 Klicken Sie in einer bestehenden Spur auf den 
Send-Selektor und wählen Sie Track.

2 Wählen Sie im Track-Untermenü die 
gewünschte Zielspur.

Neue Auxiliary-Eingangs-Spur mit automatisch Bus 
1–2 zugewiesenem Audiospur-Send

Zuweisen eines Sends zu einer bestehenden 
Auxiliary-Eingangs-Spur
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Pro Tools routet den Send über einen verfügbaren 
internen Mix-Bus automatisch zum Eingang der 
ausgewählten Spur.

Send-Formate
Mono- und Stereo-Sends – wenn Sie in einer Spur 
auf die Sends-Schaltfläche klicken, können Sie aus 
einer Liste von Mono- oder Stereoausgangspfaden 
bzw. Buspfaden auswählen. 

Mehrkanal-Sends (nur Pro Tools HD) – wenn Sie 
in einer Spur auf die Sends-Schaltfläche klicken, 
können Sie aus einer Liste von 
Mehrkanalausgangspfaden bzw. Buspfaden 
auswählen. 

Auswahlmöglichkeiten für Send-
Pfade
Zu den im Send-Selektor jeder Spur verfügbaren 
Optionen gehören Bus- und Ausgangspfade.

Interne Mix-Busse – Pro Tools verfügt über 256 
interne Mix-Busse für das interne Routen von 
Signalen. Interne Buspfade eignen sich für 
Submixe und die Plug-In-Verarbeitung. Buspfade 
werden im I/O Setup-Dialogfeld festgelegt und 
sind in allen von Ihrem System unterstützten 
Kanalformaten verfügbar (Mono, Stereo oder 
Mehrkanal).

Hardware-Ausgänge – Hardware-Sends werden 
häufig für Kopfhörer-Cue-Mischungen genutzt 
oder um Signale an externe Effektprozessoren zu 
senden. Im Unterschied zu Hardware-Inserts 
führen Sends Audio nicht automatisch zurück. 

Konfigurieren des Sends-
Bedienfelds im Mix- und Edit-
Fenster
Audiospuren, Auxiliary-Eingänge und 
Instrumentenspuren enthalten zwei Sätze von 
Sends-Bedienfeldern: Sends A–E (Sends 1–5) und 
Sends F–J (Sends 6–10). Das View-Menü bietet 
mehrere Optionen zur Anzeige der Sends im Mix- 
und Edit-Fenster.

So zeigen Sie Sends im Mix-Fenster an:

 Wählen Sie eine der folgenden Optionen:

• View > Mix Window > Sends A–E 

• View > Mix Window > Sends F–J 

So zeigen Sie Sends im Edit-Fenster an:

 Wählen Sie eine der folgenden Optionen:

• View > Edit Window > Sends A–E

• View > Edit Window > Sends F–J

Sends-Ansichtsoptionen
Sends werden im Mix- und Edit-Fenster 
entsprechend den Sends A–E- und Sends F–J-
Ansichtsoptionen angezeigt. Für jedes Sends-
Bedienfeld stehen sechs Ansichtsoptionen zur 
Wahl: die Assignments-Ansicht und fünf einzelne 
Send-Ansichten (A–E oder F–J).

Assignments-Ansicht
Dies ist die standardmäßige Sends-Ansicht, in der 
alle fünf Sends (A–E oder F–J) auf allen Spuren im 
Mix- und Edit-Fenster angezeigt werden.

Sie können die Namens-, Format- und 
Kanalzuweisungen der Busse und 
Ausgangspfade im I/O Setup-Dialogfeld 
anpassen. Siehe „Ausgangsbusse“ auf 
Seite 96.
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In der Assignments-Ansicht können Send-
Steuerelemente über Send Output-Fenster 
verändert werden (siehe „Output-Fenster für 
Spuren und Sends“ auf Seite 1009). Einige Send-
Steuerelemente können auch über erweiterte Send-
Ansichten angepasst werden (siehe „Erweiterte 
Send-Ansichten (A–J)“ auf Seite 1003).

So blenden Sie die Send-Zuweisungen ein oder aus:

 Sie haben folgende Möglichkeiten:

• Aktivieren bzw. deaktivieren Sie View > Sends 

A–E > Assignments.

• Aktivieren bzw. deaktivieren Sie View > Sends 

F-J > Assignments. 

• Klicken Sie bei gedrückter Befehls- (Mac) bzw. 
Strg-Taste (Windows) auf einen Send-Selektor, 
um zwischen der Sends- und der erweiterten 
Sends-Anzeige umzuschalten.

Erweiterte Send-Ansichten 
(A–J)
In Pro Tools können Sie eine erweiterte Ansicht 
für eine beliebige Kombination von einzelnen 
Send-Zuweisungen einblenden. Erweiterte Send-
Ansichten bieten Steuerelemente für Send-Pegel, 
-Panorama und -Stummschaltung für einen 
bestimmten Send über alle Spuren hinweg. Sends-
Bedienfelder bieten direkten Zugriff auf Send-
Steuerelemente. Sends können auch zur Steuerung 
oder Anzeige in Send-Fenstern geöffnet werden. 
Siehe „Output-Fenster für Spuren und Sends“ auf 
Seite 1009.

So erweitern Sie Sends (bzw. reduzieren Sie sie):

 Aktivieren bzw. deaktivieren Sie „View > 

Expanded Sends > Send <n> (A-J).

Assignments-Ansicht ohne Sends (links) und mit 
einem zugewiesenen Send (rechts)

Send A, Zuweisungs-Ansicht

Send-Selektoren (A–E) 

Send-Selektoren (F–J) 

Erweiterte Sends-Anzeige für Sends A, B und F

Klicken bei gedrückter Befehlstaste 
(Mac) oder Strg-Taste (Windows) auf 
einen Send-Selektor, um den Send aus- 
oder einzuklappen.
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So klappen Sie alle Sends aus:

 Klicken Sie auf View > Expanded Sends > All.

So klappen Sie alle Sends ein:

 Klicken Sie auf View > Expanded Sends > 

None.

Anzeigen in Send-Zuweisungen
In Pro Tools können in der normalen Sends-
Ansicht rechts neben dem Send-Pfadnamen in der 
Send-Zuweisungs-Schaltfläche segmentierte 
Pegelanzeigen angezeigt werden. Sends zeigen nur 
das Fader-Metering nach dem Send an.

Führen Sie zum Einblenden (oder Ausblenden) der 
Anzeigen in Send-Zuweisungen einen der 
folgenden Schritte durch:

 Klicken Sie auf Setup > Preferences > 

Metering und aktivieren (bzw. deaktivieren) Sie 
die Show Send Assignment Level Meter-Option 
(siehe „Show Send Assignment Level Meter“ 
auf Seite 124).

 Klicken Sie mit der rechten Maustaste auf eine 
Spurenanzeige und aktivieren (bzw. 
deaktivieren) Sie die Show Send Assignment 

Level Meter-Option.

Bearbeiten von Sends im Mix- 
und Edit-Fenster (individuelle 
Send-Ansichten)
Einzelansichten von Sends (etwa Send A) 
im Sends-Bereich der Mix- und Edit-Fenster 
enthalten alle Einstellungen für den jeweiligen 
Send. Diese Bedienfelder bieten vollen Zugang 
zu allen Einstellungen für diesen Send auf allen 
Spuren. 

Send-Pegelanzeige und -Stummschaltung (Mute) 
können sich nach Mix-Gruppen richten. Mehrere 
Send-Einstellungen können über eine einzige 
Steuerelementgruppe angepasst werden.

Individuelle Send-Ansichten und 
Pegelanzeigen
Wenn Sie die Steuerelemente für einen einzelnen 
Send anzeigen, können Sie zusätzlich auch die 
Send-Pegelanzeige einblenden.

Die Send-Pegelanzeige zeigt Spitzenwerte und 
während der Anzeige der Skala auftretende 
Übersteuerung an. (Falls ein Send übersteuert 
wurde, bevor die dazugehörige Skala angezeigt 
wird, ist die Übersteuerung nicht sichtbar.) Bei 
langsameren Computern kann das Ausblenden der 
Send-Pegelanzeige die Bildschirmaktualisierung 
beschleunigen.

So löschen Sie die Übersteuerungsanzeige einer 
Send-Pegelanzeige:

 Klicken Sie auf die Übersteuerungsanzeige. 

Klicken bei gedrückter Befehlstaste (Mac) 
oder Strg-Taste (Windows) auf einen Send-
Selektor, um alle Sends in einer Send-Gruppe 
(Sends A-E oder Sends F-J) aus- oder 
einzuklappen.

Assignments-Ansicht mit Pegelanzeigen

Send A-Ansicht, mit Mono-Send

Send-Selektor

Pegelanzeige 
des Sends

Send-Zuweisungs-
Schaltfläche

Send Pan

Pre-/Post-Fader 
(Schaltfläche)
Send Mute-Schaltfläche

Send Level
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Sie haben folgende Möglichkeiten, die Pegelanzeige 
zurückzusetzen:

 Klicken Sie bei gedrückter Alt- (Windows) 
bzw. Wahltaste (Mac) auf die 
Übersteuerungsanzeige.

 Wählen Sie Track > Clear All Clip Indicators.

 Drücken Sie Alt + C (Windows) bzw. Wahl + C 
(Mac).

Anzeige des Send-Status
Wenn Sie alle Einstellungen eines Sends anzeigen, 
ist der Send-Status direkt im Mix- oder Edit-
Fenster sichtbar.

In der Assignment-Ansicht wird der Send-Status 
wie folgt angezeigt:

• Standardmäßig ist die Send-Schaltfläche grau 
dargestellt, was darauf hinweist, dass der Send 
nicht stummgeschaltet ist.

• Der Text auf der Send-Schaltfläche ist rot, wenn 
der Send übersteuert wurde.

• Die Send-Schaltfläche ist blau dargestellt, wenn 
der Send stummgeschaltet ist. 

• Die Send-Schaltfläche leuchtet, wenn ein 
Fenster des Sends geöffnet ist. 

Wenn Sie eine Bedienoberfläche (etwa D-Control 
oder 003) zusammen mit Pro Tools verwenden, 
kennzeichnen farbige Umrandungen der Sends, 
Inserts und Ausgänge den aktuellen Fokus des 
Controllers.

Inaktive Sends 
Sends können inaktiv gesetzt werden. Inaktive 
Sends geben die dazugehörigen DSP- und Mixer-
Ressourcen frei, ihre Position im Sends-
Bedienfeld der Spur bleibt jedoch erhalten. 
Inaktive Sends geben kein Audio aus. Alle mit 
inaktiven Sends verbundenen Automations-
Playlists bleiben jedoch erhalten. Des Weiteren 
können Edits an Clips auf Spuren mit inaktiven 
Sends die Automations-Playlists der Sends 
beeinflussen.

Beim Öffnen von Sessions werden Sends 
automatisch deaktiviert, wenn die erforderliche 
Hardware oder andere Ressourcen nicht verfügbar 
sind. 

In der Assignment-Ansicht werden Sends 
durch Öffnen des dazugehörigen Output-
Fensters editiert. Siehe „Output-Fenster für 
Spuren und Sends“ auf Seite 1009.

Statusanzeige der Send-Stummschaltung, der Send-
Übersteuerung und des Send-Fensters

Stumm-
schaltung 
deaktiviert

Übersteuert 
(roter Text) 

Stummge-
schaltet 
(blau) 

Fenster ist geöffnet 
(aufleuchtender Send)

Anzeige inaktiver Sends

Aktiver Send 
(unformatierter 
Text)

Inaktiver Send 
(kursiv und grau 
angezeigt)

Inaktive Spur 
(gesamte Spur kursiv 
und grau angezeigt)
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Führen Sie zum Deaktivieren eines Inserts einen 
der folgenden Schritte durch:

 Halten Sie die Strg- und Windows-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) gedrückt und klicken Sie auf die Send-
Zuweisung.

 Deaktivieren Sie die Spur. Siehe „Deaktivieren 
von Spuren“ auf Seite 249.

So aktivieren oder deaktivieren Sie Sends an 
derselben Position (A–J), die auf allen Spuren 
demselben Pfad zugewiesen sind:

 Halten Sie die Strg-, Windows- und Alt-Taste 
(Windows) bzw. die Befehls-, Ctrl- und 
Wahltaste (Mac) gedrückt und klicken Sie auf 
die Send-Schaltfläche an der gewünschten 
Position.

So aktivieren oder deaktivieren Sie Sends an 
derselben Position (A–J), die auf allen 
ausgewählten Spuren demselben Pfad 
zugewiesen sind:

 Halten Sie die Strg-, Windows-, Alt- und 
Umschalttaste (Windows) bzw. die Befehls-, 
Ctrl-, Wahl- und Umschalttaste (Mac) gedrückt 
und klicken Sie auf eine Send-Schaltfläche an 
der gewünschten Position.

Verschieben oder Kopieren von 
Sends 
Sends können durch Ziehen auf andere Spuren 
(oder an andere Positionen einer Spur) verschoben 
oder kopiert werden. Sie können durch Ziehen am 
Ziel neue Sends erstellen oder bestehende Send-
Zuweisungen ersetzen. 

Sends können auf Spuren mit kompatiblen Send-
Formaten (Mono, Stereo und andere) verschoben 
und kopiert werden. Pro Tools gibt einen Hinweis 
aus, wenn Sie versuchen, einen Send an ein nicht 
kompatibles Ziel zu verschieben/kopieren. 
(Weitere Informationen finden Sie unter „Send-
Format und kompatible Spuren“ auf Seite 1006.) 

So verschieben Sie einen Send:

 Ziehen Sie den Send-Namen an die neue 
Position in derselben oder einer anderen Spur. 

So kopieren Sie einen Send:

 Ziehen Sie den Send bei gedrückter Alt- 
(Windows) bzw. Wahltaste (Mac) an eine neue 
Position. 

Beim Verschieben oder Kopieren eines Sends 
bleiben alle Routing-Zuweisungen, 
Automationsdaten, Pegel-/Panorama-
/Stummschaltungseinstellungen sowie das 
Ausgabeformat erhalten. 

Send-Format und kompatible Spuren

Sends können nur auf andere Spuren mit 
kompatiblen Send-Ausgabeformaten (Mono, 
Stereo und andere) kopiert werden. Darüber hinaus 
gelten die folgende Bedingungen beim 
Verschieben und Kopieren von Sends in Spuren:

• Beim Kopieren eines Stereo-Sends von einer 
Monospur auf eine Stereospur wird die Send-
Pan-Automation (falls verwendet) ohne 
Warnung ignoriert. 
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• Beim Kopieren eines Stereo-Sends von einer 
Stereospur auf eine Monospur bleiben die linken 
Send-Pan-Automation-Daten erhalten und die 
rechten Daten werden ignoriert. Ein 
Warnhinweis wird angezeigt und Sie können 
diesen Vorgang abbrechen. 

• Beim Verschieben und Kopieren eines Sends 
zum Ersetzen eines anderen Sends werden alle 
Automationsdaten auf dem bestehenden Send 
ersetzt. Ein Warnhinweis wird angezeigt und Sie 
können diesen Vorgang abbrechen. 

Kopieren von Spureinstellungen 
in Sends
(Nur Pro Tools HD)

Mitunter müssen Send-Einstellungen den 
Einstellungen in der Spur selbst entsprechen, etwa 
um eine auf der Hauptmischung basierende 
Kopfhörermischung zu ermöglichen. Sie können 
die aktuellen Werte oder die gesamte 
Automations-Playlist von ausgewählten Spuren 
auf beliebige Sends kopieren. 

Verknüpfen der Send Pan- und 
Main Pan-Einstellungen
Sie können Pan-Einstellungen einzelner Sends mit 
den Main Pan-Einstellungen ihrer entsprechenden 
Spuren verknüpfen. Das kann Ihnen dabei helfen, 
schnell eine Cue-Mischung (Kopfhörermischung) 
oder das Bus-Routing für die Effektverarbeitung 
einzurichten.

Verknüpfte Send Pan-Einstellungen werden 
hellgrau dargestellt.

So verknüpfen Sie die Pan-Einstellungen eines 
Sends mit den Main Pan-Einstellungen einer Spur:

1 Klicken Sie auf die Send Assignment-
Schaltfläche des Sends, den Sie verknüpfen 
möchten, um das Send-Fenster zu öffnen. 

2 Klicken Sie im Send-Fenster auf die FMP-
Schaltfläche (Follow Main Pan). 

So ändern Sie die FMP-Standardeinstellung 
(Follows Main Pan) für neu erstellte Sends:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Aktivieren oder deaktivieren Sie unter „Setup“ die 
Option Send Pans Default to Follow Main Pan.

Weitere Informationen finden Sie unter 
„Kopieren von Spurautomation auf Sends“ 
auf Seite 1088.

Follow Main Pan-Schaltfläche
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Busabfrageoptionen
Pro Tools lässt Sie Spuren auf Basis der 
Spureingangs- oder der Ausgangs-, Send- oder 
Hardware-Insert-Zuweisung auswählen oder 
anzeigen. Das kann hilfreich sein, wenn Sie 
schnell alle Spuren, die einen bestimmten 
Eingang, internen Bus, Ausgangsbus oder ein 
bestimmtes Hardware-Insert benutzen, finden 
möchten.

Rechtsklicken Sie auf den Zuweisungs-Selektor 
und wählen Sie unter den folgenden Optionen:

Zuweisungen auswählen für – wählt alle Spuren 
mit einem bestimmten Eingang, internen Bus, 
Ausgangsbus oder ein bestimmtes Hardware-
Insert.

Zuweisungen anzeigen für – zeigt alle Spuren 
(auch ausgeblendete Spuren), die einen 
bestimmten Eingang, internen Bus, Ausgangsbus 
oder ein bestimmtes Hardware-Insert benutzen. 
Alle anderen Spuren bleiben ebenfalls 
eingeblendet.

Nur Zuweisungen anzeigen für – zeigt nur 
Spuren, die einen bestimmten Eingang, internen 
Bus, Ausgangsbus oder ein bestimmtes Hardware-
Insert benutzen. Alle anderen Spuren werden 
automatisch ausgeblendet.

Früher angezeigte Spuren wiederherstellen – 
stellt den vorherigen Anzeigezustand (angezeigte 
und ausgeblendete Spuren) wieder her. Diese 
Option ist nur verfügbar, wenn Spuren mit Hilfe 
der Show Only Assignments To-Option 
ausgeblendet wurden.

So wählen Sie Spuren auf Basis der 
Spureingangs- oder der Ausgangs-, Send- oder 
Hardware-Insert-Zuweisung aus:

 Rechtsklicken Sie auf den Zuweisungs-Selektor 
und wählen Sie für den gewünschten Bus Select 

Assignments To.

Drücken Sie die Alt-Taste (Windows) bzw. 
Wahltaste (Mac), während Sie per 
Rechtsklick einen Busabfragebefehl 
auswählen, den Sie auf alle zugehörigen 
Pfade und Nebenpfade anwenden möchten. 
Drücken Sie beispielsweise die Alt-Taste 
(Windows) bzw. die Wahltaste (Mac), 
während Sie auf einen Ausgangs-Selektor 
rechtsklicken und dort „Nur Zuweisungen 
anzeigen für Bus 1“ wählen. Wenn Bus 1 ein 
Nebenpfad von Bus 1–2 ist, werden alle 
Pfade, die den Bus 1–2 sowie die Nebenpfade 
Bus 1 und Bus 2 benutzen, angezeigt, 
während alle anderen Spuren ausgeblendet 
werden.

Auswählen der Select Assignments To Bus 9-10-Option
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So zeigen Sie alle Spuren auf Basis der 
Spureingangs- oder der Ausgangs-, Send- oder 
Hardware-Insert-Zuweisung an:

 Rechtsklicken Sie auf den Zuweisungs-Selektor 
und wählen Sie für den gewünschten Bus Show 

Assignments To. Alle ausgeblendeten Spuren 
mitsamt ihren Zuweisungen werden angezeigt.

So zeigen Sie nur Spuren auf Basis der 
Spureingangs- oder der Ausgangs-, Send- oder 
Hardware-Insert-Zuweisung an:

 Rechtsklicken Sie auf den Zuweisungs-Selektor 
und wählen Sie für den gewünschten Bus Show 

Only Assignments To. Alle anderen Spuren 
werden automatisch ausgeblendet.

So stellen Sie die vorher angezeigten Spuren 
wieder her:

 Rechtsklicken Sie auf einen Zuweisungs-
Selektor und wählen Sie Restore Previously 

Shown Tracks.

Output-Fenster für Spuren 
und Sends
Track Output- und Send-Fenster bieten Standard-
Pro Tools-Steuerelemente für Spuren, Sends, 
Ziele u. a. Ausgänge und Sends können zur 
Anzeige und Bearbeitung in gesonderten Fenstern 
aufgerufen werden. 

• Die Output-Fenster bieten Spurfader sowie 
Steuerelemente für Panoramaregelung, 
Automation, Solo- und Stummschaltung. 

• Die Send-Fenster bieten Steuerelemente 
für Send-Pegel, -Stummschaltung, -
Panoramaregelung und -Automation. 

• Mit den Standard-Steuerelementen des Output- 
und Send-Fensters können Sie zusätzlich 
Routing, Zuweisungen und Anzeige einstellen.

So rufen Sie das Output-Fenster einer Spur auf:

 Klicken Sie im Kanalzug auf die Output 
Window-Schaltfläche. 

Öffnen des Output-Fensters einer Spur
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So öffnen Sie ein Send-Fenster:

 Klicken Sie im Mix- oder Edit-Fenster auf die 
Send Assignment-Schaltfläche. 

So zeigen Sie ein anderes Output- oder Send-
Fenster für eine Spur an:

 Klicken Sie im Mix- oder Edit-Fenster auf die 
Output Window- oder Send Assignment-
Schaltfläche. 

Wenn ein ähnliches Output-Fenster bereits mit 
einem hervorgehobenen Zielsymbol geöffnet war 
(rot, leuchtend), öffnet sich der neu ausgewählte 
Send an seiner Stelle. 

Aufrufen mehrerer Output-
Fenster
Es können für eine Spur mehrere Output- und 
Send-Fenster gleichzeitig angezeigt werden. 

So öffnen Sie zusätzliche Output- oder Send-
Fenster für eine Spur:

 Klicken Sie bei gedrückter Umschalttaste auf 
die Output Window- oder Send Assignment-
Schaltfläche der Spur.

So legen Sie fest, dass ein Fenster geöffnet bleibt, 
wenn Sie zusätzliche Output- oder Send-Fenster 
für die Spur öffnen:

 Das Ziel muss deaktiviert sein. 

Öffnen eines Send-Fensters

Mehrere geöffnete Send-Fenster

Ziel aktiviert Ziel deaktiviert
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Spur- oder Send-Fader, Pan-
Steuerelemente und Solo-, Mute- 
und Automation-Steuerelemente
In Output-Fenstern finden Sie Lautstärke-Fader, 
Panoramaregler, Solo- und Mute-Schalter und 
Automation Mode-Selektor der verknüpften Spur. 
Mit diesen Steuerelementen können Sie die 
Parameter des Output-Fensters einstellen oder 
automatisieren. 

Koppeln von Pannern
Stereoausgänge bieten zwei Panoramaregler, 
jeweils einen für jede Seite des Ausgangspaares. 
Mehrkanalausgänge bieten einen Mehrkanal-
Panner.

Im Output-Fenster befinden sich Steuerelemente 
zum Koppeln von Kanälen, die dazu dienen, eine 
präzise Panoramaregelung von Stereo- und 
Mehrkanal-Spuren zu erreichen.

Im gekoppelten Modus passt sich jede Seite 
den Änderungen des Panoramareglers der 
dazugehörigen anderen Seite an. Dies ist der 
Absolute Link-Modus. Weitere Informationen 
zum Verfolgen von Änderungen bei der 
Panoramaregelung erhalten Sie unter „Umgekehrt 
gekoppelte Panoramasteuerung“ auf Seite 1011.

Wenn die Panoramaregler nicht gekoppelt sind, 
arbeiten sie völlig unabhängig voneinander.

So aktivieren Sie die Kopplung:

 Aktivieren Sie das Kopplungssymbol.

So heben Sie die Kopplung von Ausgängen auf, 
um eine unabhängige Panoramaregelung zu 
erreichen:

 Deaktivieren Sie das Kopplungssymbol. 

Umgekehrt gekoppelte 
Panoramasteuerung
Wenn die Regler gekoppelt und auf den Inverse-
Modus gesetzt sind, werden die Bewegungen der 
Panoramaregler auf den anderen Kanälen 
umgekehrt. 

Durch umgekehrte Panoramarsteuerung wird die 
Position und Richtung einer Seite auf der anderen 
widergespiegelt. Wenn beispielsweise der Front-
Modus aktiviert ist und Sie die eine Seite eines 
Stereoausgangs von rechts nach links regeln, 
spiegelt die andere Seite diese Bewegung genau 
und regelt von links nach rechts. 

Die umgekehrte Kopplung (vorn) ist auf allen 
Systemen verfügbar. Die umgekehrte Kopplung 
(hinten) und die umgekehrte Kopplung 
(vorn/hinten) stehen nur auf Pro Tools HD-
Systemen zur Verfügung und erscheinen dort 
lediglich als Optionen für Mehrkanal-Plug-Ins und 
in Panner/Output-Fenstern.

So aktivieren Sie umgekehrtes Koppeln:

1 Aktivieren Sie das Kopplungssymbol.

2 Wählen Sie einen Umkehrungsmodus aus. Send-Fenster: ungekoppelt (links), gekoppelt (Mitte) 
und umgekehrte Kopplung vorn (rechts)

Kopplungs-
symbol

Umkeh-
rungssymbol

Link und Inverse-Selektoren (Mehrkanalspur)

Link 

Umkehrung vorn/hinten

Umkehrung vorn

Umkehrung hinten
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Standard-Selektoren in Output-
Fenstern
Im oberen Bereich der Output-Fenster (Output 
Editor) finden Sie Standard-Selektoren für Pfade 
und Automation sowie andere Steuerelemente.

Track-Selektor – bietet Zugriff auf beliebige 
Audiospuren, Auxiliary-Eingänge oder Master-
Fader in der Session.

Output View-Selektor – bietet Zugriff auf andere 
Ausgänge (Spur und Send) in der Spur, sofern 
vorhanden. Dazu wird der ausgewählte Ausgang 
im aktuellen Fenster angezeigt.

Send View-Selektor (nur Send-Fenster) – bietet 
Zugriff auf weitere Sends in der Spur.

Output Path-Selektor – ermöglicht die Zuweisung 
des Ausgangspfads für die aktuelle Spur bzw. den 
Send. 

Pre-/Post-Fader-Schaltfläche (nur Sends-
Fenster) – legt fest, ob der Send als Pre- oder Post-
Fader eingesetzt wird.

FMP-Schaltfläche (Follow Main Pan) (nur Sends-
Fenster) – legt fest, ob das Panning für den Send 
den Panning-Einstellungen der Spur entspricht. 
Bei aktivierter FMP-Schaltfläche stehen die 
Panning-Steuerelemente im Send-Fenster nicht 
mehr zur Verfügung und das Panning für den Send 
wird durch die Panning-Einstellungen für die Spur 
festgelegt.

Automation Safe – Track- und Send-Pegel, 
Panoramaregelung und andere Steuerelemente 
können vor automatischem Überschreiben 
geschützt werden, indem man sie in den 
Automation Safe-Modus versetzt. Weitere 
Hinweise finden Sie unter Kapitel 45: 
„Automation“. 

Schaltfläche für umgekehrte Panoramaregelung 

– die Position und Richtung einer Seite wird auf 
der anderen widergespiegelt (etwa Panoramaregler 
im linken und rechten Kanal). 

Koppeln- und Entkoppeln-Schaltfläche – 
ermöglicht das Koppeln der linken und rechten 
(oder anderen) Stereo- bzw. Mehrkanal-Ausgänge 
und das Aufheben der Kopplung. 
Der Ungekoppelt-Modus bietet gesonderte 
Anpassung einzelner Seiten oder Kanäle. Sind 
Ausgänge gekoppelt, beeinflussen alle 
Änderungen alle Kanäle. Siehe „Koppeln von 
Pannern“ auf Seite 1011. 

Target (Ziel) – bestimmt das Ziel der Plug-In-
Einstellungen. Sie stellt außerdem das aktuelle 
Fenster so ein, dass Output-Fenster angezeigt 
werden.

Standard-Steuerelemente im Output-Fenster

Standard-Steuerelemente im Send-Fenster

Track-Selektor

Path-Selektor

Automation Safe 

Target (Ziel)
Output View-
Selektor

Link

Schaltfläche für 
umgekehrte 
Panoramaregelung

Track-Selektor

Path-Selektor

Automation Safe

Link

Target (Ziel)

Send-Selektor

Pre-/Post-Fader

Follow Main Pan
Schaltfläche für 
umgekehrte 
Panoramaregelung
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Schaltfläche für Pegelanzeige des Pfads – öffnet 
die Pegelanzeige des Pfads. Diese Anzeige stellt 
die Pegel des ausgewählten Pfads dar (nicht die 
Pegel der Spuren oder Sends). 

Ausgangsanzeigen
Pro Tools bietet Ausgangsanzeigen im Transport- 
sowie im Edit-Fenster. Hier werden die 
Monitoring-Pegel für die Signale angezeigt, die 
entweder an physische Ausgänge aus der Session 
auf Ihren Audio-Interfaces oder an interne Busse 
in der Session weitergeleitet werden. Die oberste 
LED leuchtet rot und zeigt das Clipping bei den 
D/A-Wandlern Ihres Audio-Interface für die 
jeweiligen Kanäle oder internen Busse an. 

Bei Pro Tools HD-Systemen, bei denen 
Mehrkanalausgangspfade verwendet werden, 
können bis zu 8 Anzeigen eingeblendet werden. 
Die Zahl der eingeblendeten Ausgangsanzeigen 
wird durch die ausgewählten Ausgangspfade für 
Spuren bestimmt. Die Anzeigen werden nach der 
Kanalreihenfolge für die Ausgangspfade gemäß 
der Konfiguration im I/O-Setup angeordnet. 

Die mithilfe der Ausgangsanzeigen abgehörten 
Audiopfade werden über die Output Meter Path-
Einstellung auf der „I/O Setup“-Registerkarte 
bestimmt.

So richten Sie Ausgangspegel-Pfade ein:

1 Wählen Sie Setup > I/O-Setup.

2 Klicken Sie auf die Output-Registerkarte.

Pegelanzeige des Pfads in einem Send-Fenster

Path Meter 
View-
Schaltfläche

Pegelanzeige 
des Sends Pfad-

Pegelanzeigen

Path Meter-
Selektor
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3 Wählen Sie über den Ausgangspegel-
Pfadselektor den gewünschten Ausgangspfad 
für das Metering.

4 Klicken Sie auf OK.

Die Kanalreihenfolge wird durch die 
Konfiguration der Ausgangspfade im „I/O Setup“-
Dialogfeld bestimmt.

Bei allen Pro Tools-Systemen, bei denen Stereo-
Ausgangspfade verwendet werden, sind die 
Stereo-Anzeigen als „(L/R)“ gekennzeichnet.

So blenden Sie Ausgangsanzeigen im Edit- oder 
Transport-Fenster ein (bzw. aus):

 Aktivieren (oder deaktivieren) Sie im Menü des 
Edit- oder Transport-Fensters Output Meter.

Signal-Routing zum Abhören 
und Erstellen von Submixes
Die Bus- und Mischfunktionen von Pro Tools 
geben Ihnen zahlreiche Möglichkeiten zum 
Erstellen von Submixes und Abhören. Dazu 
gehören:

• Abhören und Mischen der Wiedergabe von 
Audiospuren mit Audioeingängen oder MIDI-
Instrumenten

• Bus-Submixe für Effektverarbeitung oder 
Abhören (eineschließlich Kopfhörer- oder Cue-
Mischungen)

• Mischen von Submixen mit Master-Fadern

Auswählen des Ausgangspegel-Pfads im I/O-Setup-
Dialogfeld

Die Reihenfolge der Output Meter-Kanäle wird durch 
die Ausgangskonfiguration im I/O Setup-Dialogfeld 
bestimmt.

Stereo-Ausgangsanzeigen im Transport-Fenster

Auswählen der „Output Meters“-Option im Menü des 
Transport-Fensters
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Abhören und Mischen von Audio 
mit Auxiliary-Eingangs-Spuren
Verwenden Sie Auxiliary-Eingangs-Spuren zum 
Abhören und Mischen externer Audioquellen, 
beispielweise MIDI-Instrumente, Bänder oder 
Mikrofoneingänge in einer Pro Tools-Mischung.

So verwenden Sie Auxiliary-Eingangs-Spuren zum 
Abhören und Mischen externer Audioquellen:

1 Verbinden Sie die Audioausgänge Ihrer 
Audioquelle (etwa eines MIDI-Synthesizers 
oder Bandgeräts) mit verfügbaren Eingängen 
Ihres Pro Tools-Audio-Interface. 

2 Bei Bedarf können Sie das I/O Setup-
Dialogfeld für die Eingangspfade 
konfigurieren, die Sie verwenden möchten 
(siehe Kapitel 7: „I/O-Setup“.).

3 Verwenden Sie eine bestehende oder neue 
Auxiliary-Eingangs-Spur mit dem Ihrer 
Audioquelle entsprechenden Kanalformat 
(Mono, Stereo oder Mehrkanal).

4 Legen Sie als Eingang der Auxiliary-Eingangs-
Spur den entsprechenden Eingangspfad fest.

5 Weisen Sie den Ausgang der Spur dem 
geeigneten Pfad bzw. den geeigneten Pfaden 
zum Abhören zu.

6 Passen Sie den Auxiliary-Eingangs-Fader zum 
Mischen des Audioeingangs an. 

Abhören und Mischen von Audio 
mit Instrumentenspuren
Verwenden Sie Instrumentenspuren zum Abhören 
und Mischen von Audio von Instrumenten-Plug-
Ins oder externen MIDI-Instrumenten in einer 
Pro Tools-Mischung.

So benutzen Sie eine Instrumentenspur, um die 
Ausgabe eines Intstrumenten-Plug-In abzuhören 
und zu mischen:

1 Verwenden Sie eine bestehende 
Instrumentenspur oder erstellen Sie eine neue.

2 Wählen Sie View > Mix Window > Instruments, 
um die MIDI-Steuerelemente für die 
Instrumentenspur anzuzeigen. 

3 Wählen Sie ein Instrumenten-Plug-In aus dem 
ersten Insert-Selektor auf der Instrumentenspur 
(beispielsweise Xpand2).

4 Der virtuelle MIDI-Node (Anschluss) für das 
Instrumenten-Plug-In sollte automatisch als 
MIDI-Ausgang der Instrumentenspur 
ausgewählt werden. Wenn dies nicht der Fall ist, 
wählen Sie den MIDI-Kanal sowie den 
entsprechenden Anschluss des Instrumenten-
Plug-Ins im MIDI Output-Selektor.

5 Weisen Sie den Audioausgang der Spur dem 
geeigneten Pfad bzw. den geeigneten Pfaden 
zum Abhören zu.

6 Passen Sie den Instrumentenspurfader zum 
Mischen des Audioeingangs an. 

7 Wenn Sie das Instrumenten-Plug-In von der 
Instrumentenspur aus steuern, können Sie 
ebenfalls mit den Steuerelementen für MIDI-
Lautstärke und -panorama im Instruments-
Bedienfeld mischen.
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So verwenden Sie Instrumentenspuren zum 
Abhören und Mischen von Audio von externen 
MIDI-Instrumenten:

1 Verbinden Sie die Audioausgänge des externen 
MIDI-Instruments (etwa eines MIDI-
Synthesizers) mit verfügbaren Eingängen Ihres 
Pro Tools-Audio-Interface. 

2 Bei Bedarf können Sie das I/O Setup-
Dialogfeld für die Eingangspfade 
konfigurieren, die Sie verwenden möchten 
(siehe Kapitel 7: „I/O-Setup“.).

3 Verbinden Sie den MIDI-Eingang und -
Ausgang des externen MIDI-Instruments mit 
verfügbaren MIDI-Eingangs- und -
Ausgangsanschlüssen des MIDI-Interface.

4 Konfigurieren Sie ggf. MIDI Studio Setup 
(Setup > MIDI > MIDI Studio). 

5 Verwenden Sie eine bestehende oder neue 
Instrumentenspur mit dem Ihrer Audioquelle 
entsprechenden Kanalformat (Mono, Stereo 
oder Mehrkanal).

6 Wählen Sie View > Mix Window > Instruments, 
um die MIDI-Steuerelemente für die 
Instrumentenspur anzuzeigen. 

7 Legen Sie für den Audio-Eingang der 
Instrumentenspur den entsprechenden 
Eingangspfad fest.

8 Richten Sie im Instruments-Bedienfeld der 
Instrumentenspur den MIDI-Ausgang auf den 
MIDI-Anschluss ein, der mit dem MIDI-
Eingang des externen MIDI-Instruments 
verbunden ist.

Informationen über das Konfigurieren von 
Audio- und MIDI-Signal-Routing zum 
Steuern und Abhören von ReWire-Client-
Anwendungen finden Sie im Audio-Plug-Ins-
Handbuch.

Instrumentenspur, konfiguriert zum Steuern und 
Abhören eines Instrumenten-Plug-Ins (Xpand2)

MIDI Input-Selektor

MIDI-Lautstärkeregler
MIDI-Pan-Steuerung

MIDI Mute

MIDI Output-Selektor

MIDI Velocity-Anzeige

Instrumenten-Plug-In

Audio Input-Selektor 
(kein Eingang 
eingestellt)Audio Output-

Selektor
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9 Weisen Sie den Ausgang der Spur dem 
geeigneten Pfad bzw. den geeigneten Pfaden 
zum Abhören zu.

10 Passen Sie den Instrumentenspurfader zum 
Mischen des Audioeingangs an. 

11 Wenn Sie das externe MIDI-Instrument von der 
Instrumentenspur aus steuern, können Sie 
ebenfalls mit den Steuerelementen für MIDI-
Lautstärke und -panorama im Instruments-
Bedienfeld mischen.

Abhören und Mischen von Audio von einem 
Instrumenten-Plug-In mit mehreren 
Audioausgängen:

1 Verwenden Sie eine bestehende 
Instrumentenspur oder erstellen Sie eine neue.

2 Wählen Sie View > Mix Window > Instruments, 
um die MIDI-Steuerelemente für die 
Instrumentenspur anzuzeigen. 

3 Wählen Sie aus dem ersten Insert-Selektor auf 
der Instrumentenspur ein Instrumenten-Plug-In 
mit mehreren Ausgängen (beispielsweise 
Xpand!2).

4 Der virtuelle MIDI-Node (Anschluss) für das 
Instrumenten-Plug-In sollte automatisch als 
MIDI-Ausgang der Instrumentenspur 
ausgewählt werden. Wenn dies nicht der Fall ist, 
wählen Sie den MIDI-Kanal sowie den 
entsprechenden Anschluss des Instrumenten-
Plug-Ins.

5 Weisen Sie im Plug-In-Fenster die einzelnen 
Audioausgänge des Plug-Ins zu.

6 Erstellen Sie eine Auxiliary-Eingangs-Spur für 
jeden Ausgang des Plug-Ins. Stellen Sie sicher, 
dass das Kanalformat der Auxiliary-Eingänge 
dem Kanalformat der Plug-In-Ausgänge 
(Mono, Stereo oder Mehrkanal) entspricht.

7 Stellen Sie die Eingänge der Auxiliary-
Eingangs-Spuren so ein, dass sie die einzelnen 
Ausgänge des Plug-Ins empfangen. 

8 Weisen Sie die Ausgänge der Auxiliary-
Eingangs-Spuren dem geeigneten Pfad bzw. 
den geeigneten Pfaden zum Monitoring zu.

Instrumentenspur, konfiguriert zum Steuern und 
Abhören eines externen MIDI-Instruments (K2600)

MIDI Input-Selektor

MIDI-Lautstärkeregler

MIDI-Pan-Steuerung

Audio Output-
Selektor

MIDI Mute

MIDI Output-Selektor

MIDI Velocity-Anzeige

Audio Input-Selektor 
(Eingang für externes 
MIDI-Gerät eingestellt)
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9 Passen Sie die Auxiliary-Eingangs-Fader 
an, um die einzelnen Ausgänge des Plug-Ins 
zu mischen.

Erstellen eines Submix
Sie erstellen einen Submix, indem Sie mehrere 
Audioquellen zu einem gemeinsamen Bus- oder 
Ausgangspfad routen. Dadurch werden die 
Quellen in einen einzelnen Pfad gemischt, 
der an einen Auxiliary-Eingang zurückgegeben 
werden kann, an dem der Submix mit Plug-Ins 
oder einem externen Effektgerät verarbeitet 
werden kann.

Audio wird auf einen Submix geroutet, indem 
Sie verfügbaren Bus- oder Ausgangspfaden eine 
beliebige Kombination von Sends und Ausgängen 
zuweisen.

Erstellen von Submixen mit Spurausgängen 
oder Sends 

Sie können Audio für Submixe sowohl über 
Ausgänge als auch über Sends routen, je nachdem, 
ob Sie einen separaten oder einen Send-und-
Return-Submix möchten. 

Instrumenten-Plug-In mit mehreren Ausgängen, 
die auf Auxiliary-Eingangs-Spuren geroutet wurden

 Instrumenten-
Plug-In 

Eingänge 
von Plug-In-
Ausgängen

Stellen Sie beim Routen von Mono-Signalen 
mit internen Mix-Bussen sicher, dass Mono-
Busse verwendet und keine Stereo-Busse 
gesplittet werden. Da Pro Tools die 
Phasenanpassung von Stereo-Bussen 
beibehält, kann deren Splittung einen 
ungenauen Verzögerungsausgleich zur Folge 
haben.
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Separater Submix-Ausgang
In Pro Tools können Sie eine Audioquelle separat 
durch einen Submix routen. Diese Methode ist für 
Dithering und andere Mastering-Verarbeitungen 
von Vorteil, wenn kein unverarbeitetes Audio 
zusätzlich zum verarbeiteten Signal hörbar sein 
soll. Mithilfe von Spurausgängen (keine Sends) 
können Sie Buspfaden Spuren zuweisen, um 
separate Submixe zu erstellen. In dieser 
Anordnung wird das Gleichgewicht von 
verarbeiteten und unverarbeiteten Signalen durch 
die Wet/Dry-Einstellungen für Plug-Ins gesteuert.

So erstellen Sie einen separaten Submix:

1 Legen Sie den Ausgang der Spuren, die in den 
Submix aufgenommen werden sollen, auf einen 
internen Stereo-Buspfad. 

2 Pannen Sie jede Spur.

3 Wählen Sie Track > New.

4 Geben Sie die Spurart (Aux Input) und das 
Format (Stereo) an und klicken Sie auf Create.

5 Legen Sie die Eingabe des Auxiliary-Eingangs 
auf denselben Buspfad, dem alle im Submix 
enthaltenen Spuren zugewiesen wurden.

6 Legen Sie die Ausgabe der Auxiliary-Eingangs-
Spur auf die Hauptstereoausgänge für die 
Mischung (normalerweise Ausgänge 1–2). 

7 Stellen Sie den Pegel der Auxiliary-Eingangs-
Spur ein.

8 Um den Submix zu editieren, weisen Sie dem 
Auxiliary-Eingang ein Plug-In oder ein 
Hardware-Insert zu. 

9 Stellen Sie die Steuerelemente des Plug-Ins ein. 
Mit den Bypass- und Wet/Dry-Steuerelementen 
des Plug-Ins (falls verfügbar) wird der hörbare 
Effektanteil bestimmt.

Die beteiligten Spurfader steuern die Balance 
innerhalb des Submixes. Die Auxiliary-Eingangs-
Spur steuert die Ausgangspegel aller Spuren, die 
darauf geroutet sind. 

Sie können Mischautomation auf die 
Steuerelemente für Lautstärke, Panorama, 
Stummschaltung und Send-Pegel, Send-
Panoramaregelung und Send-Stummschaltung des 
Auxiliary-Eingangs anwenden.

Sie können einen Submix auch auf Festplatte 
bouncen, um die Voices für andere Spuren 
freizumachen. Weitere Hinweise finden Sie unter 
Kapitel 46: „Mixdown“.

Erstellen von Send- und Return-
Submixen zur 
Effektverarbeitung
Wenn Sie Submixe zur Verarbeitung von Hall-, 
Delay- und ähnlichen Effekten erstellen möchten, 
verwenden Sie Sends, um traditionelle Send-
/Return-Busse zu erstellen. Sie können ein Echtzeit-
Plug-In oder ein Hardware-Insert als gemeinsame 
Ressource für alle an einem Submix beteiligten 
Spuren nutzen. Die Wet/Dry-Balance der Mischung 
kann mithilfe der Spurfader (Dry-Pegel) und 
Auxiliary-Eingangs-Fader (Effekt-Return oder 
Wet-Pegel) gesteuert werden.

Weitere Hinweise finden Sie unter 
Kapitel 44: „Plug-In- und Hardware-
Inserts“.
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So erstellen Sie Return-Submixe für Effekte mit 
einem Plug-In- oder Hardware-Insert:

1 Weisen Sie Ihren Hauptmischausgängen den 
Hauptausgang jeder Spur zu.

2 Weisen Sie auf den Ausgangsspuren einen Send 
(Mono oder Stereo) zu und wählen Sie im Send-
Selektor einen Mono- oder Stereobuspfad aus. 
Konfigurieren Sie die Sends je nach Bedarf für 
einen Pre- oder Post-Fader-Einsatz.

3 Wählen Sie Track > New.

4 Geben Sie die Spurart (Aux Input) und das 
Format (Stereo) an und klicken Sie auf Create.

5 Wählen Sie im Input Path-Selektor der 
Auxiliary-Eingangs-Spur den Pfad für den 
Send-Bus.

6 Wenden Sie die Solo Safe-Funktion auf die 
Spur an. Wenn Sie dann eine andere Spur 
soloschalten, die den Effekt-Send verwendet, 
schalten Sie den Effekt-Return nicht stumm 
(siehe „Solo Safe-Modus“ auf Seite 248).

7 Weisen Sie ein Plug-In- oder Hardware-Insert 
im Auxiliary-Eingang zu.

8 Legen Sie für den Effekt „100 % wet“ fest und 
konfigurieren Sie alle anderen Steuerelemente.

9 Wählen Sie im Output Path-Selektor der 
Auxiliary-Eingangs-Spur einen Ausgangspfad 
(Hauptausgang) aus.

Passen Sie die einzelnen Spurfader an, sodass 
unverarbeitete Spuren (Dry-Spuren) ausgeglichen 
sind. Wenn der Send auf Pre-Fader eingestellt ist, 
wird der Effektanteil durch den Pegel des Send-
Faders oder den Lautstärke-Fader des Auxiliary-
Eingangs geregelt. Wenn der Send auf Post-Fader 
eingestellt ist, regelt der Lautstärkepegel den 
Send-Pegel-Fader.

Send-/Return-Einstellung eines Plug-In- oder 
Hardware-Inserts

Insert-Effekt (Plug-In oder 
Hadware)

Send an Effektbus

Pegelsteuerung für Send an 
Effektbus

Eingang auf Pfad für den 
Send-Bus gelegt

Ausgang auf Main Mix-
Ausgänge eingestellt 

Pegelsteuerung für Effekt-Return

Pegelsteuerung für Dry-Signal
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Send- und Return-Submixe bei 
externen Geräten

So erstellen Sie den Return-Submix eines Effekts 
bei einem externen Gerät:

1 Weisen Sie Ihren Hauptmischausgängen den 
Hauptausgang jeder Spur zu.

2 Weisen Sie einen Send (Mono oder Stereo) 
zu und legen Sie die Send-Ziele in den 
Ausgangsspuren auf den mit dem externen 
Gerät verbundenen Ausgangspfad fest. 
Konfigurieren Sie die Sends je nach Bedarf für 
einen Pre- oder Post-Fader-Einsatz.

3 Wählen Sie Track > New.

4 Geben Sie die Spurart (Aux Input) und das 
Format (Stereo oder Mono) an. Klicken Sie 
dann auf Create.

5 Wählen Sie im Input Path-Selektor der 
Auxiliary-Eingangs-Spur den mit dem externen 
Gerät verbundenen Eingangspfad aus.

6 Wählen Sie im Output Path-Selektor der 
Auxiliary-Eingangs-Spur einen Ausgangspfad 
(Hauptausgang) aus.

7 Passen Sie die einzelnen Spurfader an, sodass 
unverarbeitete Spuren (Dry-Spuren) 
ausgeglichen sind. 

Der Effektanteil wird durch den Pegel des Send-
Faders oder den Lautstärke-Fader des Auxiliary-
Eingangs geregelt.

Send-/Return-Einstellung für ein externes Gerät

Send zu externem Gerät

Pegelsteuerung für Send an 
externes Gerät

Eingang auf Pfad für den Return 
des Geräts eingestellt

Ausgang auf Main Mix-
Ausgänge eingestellt 

Pegelsteuerung für Effekt-
Return

Pegelsteuerung für Dry-Signal
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Erstellen von Submixen zum 
Abhören
Routen Sie Spur-Sends an eine oder mehrere 
Auxiliary-Eingangs-Spuren zum Abhören der 
Submixe in einer Studioumgebung. Sie können die 
Hauptmischung für ein bzw. mehrere Paare von 
Audioausgängen im Control Room abhören und 
gleichzeitig einen Submix für eine Kopfhörer- oder 
Cue-Mischung für den Musiker an ein anderes Paar 
von Audioausgängen routen. Sie können 
beispielsweise einen Submix der Drums für den 
Bassisten und eine eigene Spur zum Overdubbing 
eines neuen Basslaufs bereitstellen.

So erstellen Sie einen Submix zum Abhören:

1 Weisen Sie Ihren Hauptmischausgängen den 
Hauptausgang jeder Spur zu.

2 Weisen Sie einen Send (Mono oder Stereo) zu 
und legen Sie die Send-Ziele in den 
Ausgangsspuren auf den mit dem externen 
Gerät verbundenen Ausgangspfad fest. 
Konfigurieren Sie die Sends je nach Bedarf für 
einen Pre- oder Post-Fader-Einsatz.

3 Wählen Sie Track > New.

4 Geben Sie die Spurart (Aux Input) und das 
Format (Stereo oder Mono) an. Klicken Sie 
dann auf Create.

5 Wählen Sie im Output Path-Selektor der 
Auxiliary-Eingangs-Spur den Ausgangspfad 
(nicht den Hauptausgang) zum Abhören der 
Mischung aus. 

Passen Sie den Auxiliary-Eingangs-Spurfader zur 
Steuerung der Lautstärke der Mischung an.

Bei Cue-Mischungen wird beim Aufnehmen 
von Overdubs empfohlen, keine Inserts (oder 
zumindest nur Inserts mit sehr kurzen 
Verzögerungen) auf der aufgenommenen Spur 
einzufügen, um unnötige Latenz im 
Abhörsignalpfad zu vermeiden.

Drum-Submix zum Abhören
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Erstellen einer Steuerung des 
Master-Send-Pegels 
Mit Master-Fadern können Sie den Gesamtpegel 
der Ausgangs- und Buspfade steuern. 

So erstellen Sie eine Steuerung des Master-Send-
Pegels:

1 Wählen Sie Track > New.

2 Geben Sie die Spurart (Master-Fader) und das 
Format an (Mono, Stereo oder eines der 
unterstützten Mehrkanalformate für Surround-
Mischungen).

3 Klicken Sie auf Create.

4 Sie haben folgende Möglichkeiten:

• Legen Sie die Ausgabe des Master-Faders auf 
denselben Pfad, den Sie verwenden, um an eine 
Auxiliary-Eingangs-Spur zu senden.

• Richten Sie den Ausgang des Master-Faders so 
ein, dass er dem Pfad entspricht, den Sie für 
Ihren Effekt-Send gewählt haben.

Anschließend können Sie die Send-Pegel 
anpassen, um die Pegelverhältnisse der 
Originalspuren zu bestimmen, und den Master-
Fader als Master-Pegelsteuerung für den gesamten 
Submix verwenden.

Soloschalten von Spuren in 
einem Submix
Durch das Soloschalten einer Spur werden alle 
anderen Spuren, einschließlich des Auxiliary-
Eingangs, stummgeschaltet. Wenn Sie die Solo 
Safe-Funktion auf einen Auxiliary-Eingang 
anwenden, wird seine Stummschaltung verhindert 
und er kann Audio weiterleiten, wenn seine 
Quellspuren sologeschaltet wurden.

So wenden Sie die Solo Safe-Option auf einen 
Auxiliary-Eingang an:

 Klicken Sie bei gedrückter Strg-Taste (Windows) 
bzw. Befehlstaste (Mac) auf die Solo-
Schaltfläche der Auxiliary-Eingangs-Spur.

So schalten Sie eine in einer Gruppe enthaltene 
Spur solo:

 Klicken Sie mit gedrückter Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) auf die Solo-
Schaltfläche. 

Erzeugen einer Stereoausgabe 
aus einem Mono-Send/-Return
Mithilfe eines Auxiliary-Eingangs können Sie 
Stereosignale aus einem Mono-Send erzeugen. 
Bestimmen Sie für das Send-Ziel eine Auxiliary-
Eingangs-Spur in Mono und platzieren Sie ein 
Mono-To-Stereo-Plug-In auf dem Auxiliary-
Eingang. Daraufhin werden die Signale in Stereo 
ausgegeben. 

Um Monomaterial in Stereo zu verwandeln, müssen 
Sie einen Hall- oder Verzögerungseffekt oder einen 
anderen zeitbezogenen Effekt anwenden.
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Verzögerungsausgleich
Pro Tools bietet eine automatische 
Verzögerungsausgleichsfunktion für DSP-
Verzögerungen und hostbasierte Verzögerungen 
durch Plug-In-Inserts sowie Mixer-Routing (Busse 
und Sends). Bei aktiviertem 
Verzögerungsausgleich (Delay Compensation) 
wendet Pro Tools einen phasenkohärenten 
Zeitausgleich auf Spuren mit Plug-Ins und 
unterschiedlichen Signalverzögerungen, Spuren 
mit unterschiedlichen Mischpfaden, Spuren, 
die gesplittet und im Mixer wieder 
zusammengesetzt wurden, sowie Spuren mit 
Hardware-Inserts an.

Bei aktiviertem Verzögerungsausgleich weist 
Pro Tools für diese Funktion jedem Kanal 
16.383 Samples (bei 44,1/48 kHz), 32.767 Samples 
(bei 88,2/96 kHz) oder 65.534 Samples (bei 
176,4/192 kHz) zu. Wählen Sie diese Einstellung 
für Sessions mit Plug-Ins auf Mischpult-Kanälen, 
die bei 48 kHz über mehr als 4.000 Samples mit 
Signalverzögerung verfügen.

Für einen phasenkohärenten Zeitausgleich sollte 
der Verzögerungsausgleich während der 
Wiedergabe und des Mischens immer aktiviert 
sein. Der Verzögerungsausgleich sollte in den 
meisten Aufnahmesituationen verwendet werden.

Aktivieren des 
Verzögerungsausgleichs

So aktivieren Sie den Verzögerungsausgleich:

 Wählen Sie Options > Delay Compensation.

Wenn der Verzögerungsausgleich aktiviert ist, 
wird die entsprechende Statusanzeige in der 
Symbolleiste des Edit-Fensters angezeigt.

Die Anzeige für den Verzögerungsausgleich für 
Spuren kann im Mix-Fenster angezeigt werden 
(siehe „Delay Compensation-Bedienfeld“ auf 
Seite 1025).

Anzeige für den Verzögerungsausgleich

Die Anzeige für den Verzögerungsausgleich 
im Edit-Fenster wird rot, wenn es 
Verzögerungen in der Session gibt, die den 
maximal verfügbaren 
Verzögerungsausgleich überschreiten (siehe 
„Verzögerungen, die die Ausgleichsgrenze 
überschreiten“ auf Seite 1027).

Rot kann auch darauf hinweisen, dass Sie 
eine Feedback-Schleife erstellt haben, für die 
es keinen Ausgleich gibt. Wenn 
beispielsweise der Ausgang einer Spur auf 
den Eingang derselben Spur geroutet wird. 
Bewegen Sie den Mauszeiger über die 
Anzeige für den Verzögerungsausgleich im 
Edit-Fenster, um festzustellen, ob die 
QuickInfo dies als Problem erkennt.



Kapitel 43: Einfaches Mixen 1025

Delay Compensation Time Mode
Die Verzögerungswerte können je nach den 
gewählten Voreinstellungen auf der Operation 
Preferences-Registerkarte unter Delay 

Compensation Time Mode entweder in Samples 
oder in Millisekunden angegeben werden. 

Systemverzögerung
Pro Tools fügt jeder Spur die notwendige 
Verzögerung hinzu, damit die Länge der 
Verzögerung der betreffenden Spur gleich der 
gesamten Systemverzögerung ist. Die gesamte 
Systemverzögerung ist die längste Verzögerung 
auf einer Spur, plus zusätzlicher Verzögerungen 
durch Mixer-Routing.

Die Systemverzögerung wird im Session Setup-
Fenster (Session > Setup) angezeigt. Prüfen Sie 
die angegebene Systemverzögerung, um zu 
überwachen, wann die Grenze für den 
Verzögerungsausgleich erreicht sein wird.

Delay Compensation-Bedienfeld
Im Delay Compensation-Bedienfeld werden die 
gesamte Plug-In-Verzögerung und Hardware-
Insert-Verzögerung (nur HD) und die 
Gesamtlänge der Verzögerung angezeigt, die 
Pro Tools auf jede Spur anwendet. Sie können 
auch ein Offset für die Spurverzögerung auf 
einzelne Spuren anwenden. Das Delay 
Compensation-Bedienfeld kann im Mix-Fenster 
angezeigt werden.

So zeigen Sie das Delay Compensation-
Bedienfeld mit Informationen zum 
Verzögerungsausgleich an: 

 Wählen Sie View > Mix Window > Delay 

Compensation.

Systemverzögerung im Session Setup-Fenster

Bei der Verwendung des automatischen 
Verzögerungsausgleichs berücksichtigt 
Pro Tools HD Wandlerverzögerungen. Wird 
jedoch Nicht-HD-Hardware verwendet, zeigt 
die Systemverzögerung nur interne 
Verzögerungen an und berücksichtigt keine 
durch die ADC- oder DAC-Wandler bedingte 
Latenz in Ihrem Audio-Interface.

Delay Compensation-Bedienfeld

Im Delay Compensation-Bedienfeld wird nur 
die Insert-Verzögerung für jede Spur 
angezeigt. Die gesamte Systemverzögerung, 
einschließlich Mixerverzögerungen, finden 
Sie im Session Setup-Fenster unter „System 
Delay“ (siehe „Systemverzögerung“ auf 
Seite 1025).

 
 

Verzögerungs-
anzeige
Feld für 
benutzerdefiniertes 
Offset
Anzeige für 
Spurausgleich
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Anzeigen und Felder des Delay 
Compensation-Bedienfelds

Anzeige für Verzögerung (dly)

Mit der dly-Anzeige wird die gesamte Plug-In- und 
Hardware-Insert-Verzögerung für die Spur 
angegeben. Der Verzögerungsbericht an die 
Delay Compensation Engine von Pro Tools kann 
umgangen werden, wenn der Verzögerungsausgleich 
aktiviert ist. Dies ist hilfreich für die manuelle 
zeitliche Abstimmung einer Spur oder wenn die 
Gesamtverzögerung einer Spur die Grenze für den 
Verzögerungsausgleich überschreitet. Siehe 
„Verzögerungen, die die Ausgleichsgrenze 
überschreiten“ auf Seite 1027.

Die Anzeigefarbe gibt die jeweilige 
Spurverzögerung an:

Grün – gibt an, dass die Überwachung der 
Spurverzögerung aktiviert ist und die Spur nicht 
den verfügbaren Verzögerungsausgleich 
überschreitet.

Orange – gibt an, dass diese Spur die längste Plug-
In- und Hardware-Insert-Verzögerung in der 
Session aufweist. 

Rot – gibt an, dass die gesamte Plug-In- und 
Hardware-Insert-Verzögerung der Spur den 
verfügbaren Verzögerungsausgleich überschreitet 
(siehe „Verzögerungen, die die Ausgleichsgrenze 
überschreiten“ auf Seite 1027). 

Grau – gibt an, dass die Überwachung der 
Spurverzögerung umgangen wird.

Feld für benutzerdefiniertes Offset (+/–) 

In diesem Feld können Sie bei aktiviertem 
Verzögerungsausgleich Spurverzögerungen 
manuell anpassen. Das benutzerdefinierte Offset 
gilt zusätzlich zur Verzögerung, die für den 
Spurausgleich gilt, oder wird davon abgezogen. 
Das benutzerdefinierte Offset ist in folgenden 
Fällen hilfreich:

• Zur manuellen zeitlichen Abstimmung einer 
Spur, wenn ein Plug-In eine falsche 
Verzögerung anzeigt.

• Zum Anpassen des zeitlichen „Feelings“ 
einer Spur.

So ändern Sie mithilfe des Felds für das 
benutzerdefinierte Offset (+/–) die 
Spurverzögerung:

1 Klicken Sie im Delay Compensation-
Bedienfeld auf das User Offset-Edit-Feld.

2 Zum Einstellen des gewünschten 
Verzögerungswerts (in Samples oder 
Millisekunden, je nach aktueller Voreinstellung), 
haben Sie folgende Möglichkeiten:

• Geben Sie eine positive Zahl (mit oder ohne 
Pluszeichen (+)) für eine positive Verzögerung 
(später) oder eine negative Zahl (mit 
Minuszeichen (–)) für eine negative 
Verzögerung (früher) ein. 

• Ziehen Sie im User Offset-Feld, um einen neuen 
Wert zu erhalten. Um detailliertere 
Anpassungen vorzunehmen, ziehen Sie bei 
gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac).

• Verwenden Sie die Nach-oben- oder Nach-
unten-Pfeiltaste, um die Zahlenwerte zu erhöhen 
bzw. zu verringern. 

3 Drücken Sie die Eingabetaste.
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So schalten Sie eine benutzerdefinierte 
Verzögerung auf Bypass:

 Halten Sie die Befehls- und die Ctrl-Taste 
(Mac) bzw. die Windows- und die Strg-Taste 
(Windows) gedrückt und klicken Sie auf das 
User Offset-Feld. Die benutzerdefinierte 
Verzögerung wird abgeblendet dargestellt und 
nicht auf die Spur angewendet.

Anzeige für Spurausgleich (cmp) 

Diese Anzeige zeigt an, wie viel 
Verzögerungsausgleich Pro Tools auf jede 
einzelne Spur anwendet. 

Mit folgenden Farben wird der angewendete 
Verzögerungsausgleich angegeben:

Grün – der Spurausgleich ist aktiviert und die Spur 
überschreitet nicht die Grenze für den 
Verzögerungsausgleich. Der angezeigte 
Verzögerungsausgleich wird auf die Spur 
angewendet.

Blau (nur Audiospuren) – zeigt an, dass der 
Verzögerungsausgleich für die Spur erzwungen 
wird. Wenn die Spur scharfgeschaltet oder 
TrackInput-aktiviert ist, wird der 
Verzögerungsausgleich nicht aufgehoben und 
bleibt aktiviert (siehe „Außerkraftsetzen der Low 
Latency Monitoring-Option während der 
Aufnahme“ auf Seite 1028).

Rot – zeigt an, dass die Spurverzögerung den 
zulässigen Verzögerungsausgleich überschreitet 
und kein Verzögerungsausgleich auf die Spur 
angewendet wird (siehe „Verzögerungen, die die 
Ausgleichsgrenze überschreiten“ auf Seite 1027). 

Grau – gibt an, dass der Verzögerungsausgleich 
für die Spur umgangen wird und keine 
Verzögerung auf die Spur angewendet wird.

Verzögerungsausgleich für 
Sidechains
(Nur Pro Tools|HDX-Systeme)

In Pro Tools|HDX-Systemen können Sie 
Signalverzögerungen bei der Sidechain-
Verarbeitung automatisch ausgleichen. In einigen 
Fällen bietet es sich an, den automatischen 
Verzögerungsausgleich für Sidechains zu 
deaktivieren (z. B. bei Sessions, die mit früheren 
Versionen von Pro Tools erstellt wurden und für 
die Sie Sidechain-Verzögerungen manuell 
ausgeglichen haben).

So aktivieren (bzw. deaktivieren) Sie den 
automatischen Verzögerungsausgleich für 
Sidechains:

1 Wählen Sie Setup > Preferences.

2 Klicken Sie auf Operation-Registerkarte.

3 Aktivieren (oder deaktivieren) Sie die 
Compensate Side Chains-Option.

4 Klicken Sie auf OK.

Verzögerungen, die die 
Ausgleichsgrenze überschreiten
Wenn die gesamte Verzögerung auf einer Spur den 
insgesamt verfügbaren Verzögerungsausgleich 
(im Playback Engine-Dialogfeld eingestellt) 
überschreitet, wird kein Verzögerungsausgleich auf 
die Spur angewendet. Die Audiodaten auf dieser 
Spur sind nicht mehr zeitlich aufeinander 
abgestimmt und die Phasen verschoben. 
Die Anzeigen für den Verzögerungsausgleich 
und den Spurausgleich werden rot angezeigt, 
um den Benutzer darauf hinzuweisen, dass 
die Spurverzögerung die Grenze für den 
Verzögerungsausgleich überschreitet. Der maximal 
verfügbare Verzögerungsausgleich wird auf alle 
anderen Spuren angewendet. 
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Sie können die Verzögerung für Spuren, die die 
Grenze für den Verzögerungsausgleich 
überschreiten, jedoch manuell ausgleichen.

So gleichen Sie Verzögerungen aus, die die 
Ausgleichsgrenze überschreiten:

1 Umgehen Sie die angegebene Verzögerung für 
die Spur, indem Sie einen der folgenden 
Schritte ausführen:

• Klicken Sie bei gedrückter Befehls- und ctrl-
Taste (Mac) bzw. gedrückter Windows- und 
Strg-Taste auf die Verzögerungsanzeige. 

• Klicken Sie mit der rechten Maustaste auf die 
Verzögerungsanzeige und wählen Sie Disable 

Plug-In Delay.

Die Spurdaten werden abgeblendet, nachdem sie 
umgangen wurden.

2 Verschieben Sie Audiodaten um den auf der 
Verzögerungsanzeige der Spur angegebenen Wert.

 

Niedriglatenz-Monitoring 
während der Aufnahme
Wenn eine Audiospur scharfgeschaltet ist, 
TrackInput oder DestructivePunch aktiviert ist oder 
ein Punch-In auf der Spur durchgeführt wird, wird 
der Verzögerungsausgleich für diese Spur 
automatisch ausgesetzt und die Anzeige für den 
Spurenausgleich zeigt 0 an. Dadurch wird die 
Abhörlatenz für solche Spurausgaben verringert. 
Bei der Wiedergabe der Spur (Scharfschaltung und 
TrackInput deaktiviert) sind das aufgezeichnete 
Material und die ausgeglichene Mischung korrekt 
aufeinander abgestimmt.

Auf nicht scharfgeschaltete Spuren wird weiterhin 
der Verzögerungsausgleich angewendet. Pro Tools 
kompensiert automatisch die Zeitunterschiede 
zwischen dem aufgezeichneten Material und der 
Mischung, auf die ein Verzögerungsausgleich 
angewendet wurde. 

Außerkraftsetzen der Low 
Latency Monitoring-Option 
während der Aufnahme
Sie können die Low Latency Monitoring-Option 
während der Aufnahme auf scharfgeschaltete 
Spuren außer Kraf setzen, was allerdings zu einer 
Latenz im Signalpfad führen kann, die dem 
Verzögerungsausgleich entspricht. Diese Latenz 
kann abhängig von der Aufnahmequelle 
akzeptabel sein. Beispielsweise wird bei 
bestimmten Non-Performance-Arbeitsabläufen 
durch Überschreiben der Low Latency 
Monitoring-Option während der Aufnahme 
sichergestellt, dass der Verzögerungsausgleich 
fortlaufend angewendet wird, unabhängig davon, 
ob eine Spur scharfgeschaltet bzw. Punch-aktiviert 
ist oder ob Pro Tools gerade eine Aufnahme oder 
Wiedergabe ausführt.

So setzen Sie die Low Latency Monitoring-Option 
während der Aufnahme für bestimmte 
Aufnahmespuren außer Kraft:

 Halten Sie die Windows- und Strg-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) gedrückt und klicken Sie auf die Anzeige 
für den Spurausgleich. Verzögerungsausgleich 
wird auf die Spur angewendet und die Anzeige 
für Spurenausgleich in blauer Farbe angezeigt.

Verwenden Sie die Time Adjuster-Plug-Ins 
für manuelles Offset der Spuren in Echtzeit. 
Weitere Informationen finden Sie im Audio-
Plug-Ins-Handbuch.

Bei einigen Dubbing-Arbeitsabläufen können 
Sie Bus-Recordings für mehrere Spuren 
hintereinanderschalten. In diesen Fällen 
sollten Sie die Low Latency Monitoring-
Option für die aufzunehmenden Spuren 
überschreiben.
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Verzögerungsausgleich auf 
Auxiliary-Eingängen
Der Verzögerungsausgleich auf Auxiliary-
Eingängen kann auf Bypass geschaltet werden, um 
Quellen von außerhalb (wie etwa die Audiospuren 
eines als Slave angeschlossenen Videodecks) mit 
minimaler Latenz abhören und dennoch 
gleichzeitig die Verzögerung der Spur anzeigen zu 
können.

So schalten Sie den Verzögerungsausgleich eines 
Auxiliary-Eingangs auf Bypass:

 Halten Sie die Windows- und Strg-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) gedrückt und klicken Sie auf die Anzeige 
für den Spurausgleich. Die Spurverzögerung 
wird auf null gesetzt und ausgegraut angezeigt.

Verzögerungsausgleich für MIDI
Pro Tools behält automatisch die zeitliche 
Abstimmung zwischen aufgezeichneten MIDI-
Events und der Wiedergabe mit 
Verzögerungsausgleich bei. 

Bei aktivem Verzögerungsausgleich wird ein 
MIDI-Event, das so aufgenommen ist, dass es 
zeitgleich mit bereits ausgeglichenem Material 
erklingt, in Wirklichkeit „später“ aufgenommen, 
wobei dieser Zeitraum der derzeit auftretenden 
Gesamtverzögerung entspricht. Um dies 
auszugleichen, werden MIDI-Events nach jedem 
MIDI-Aufnahmedurchgang um den gleichen 
Zeitraum wieder nach hinten verschoben. Bei der 
MIDI-Wiedergabe nach einem 
Aufnahmedurchgang mit aktiviertem 
Verzögerungsausgleich wird der Aufnahmepfad 
mit geringer Latenz berücksichtigt und die 
phasenkohärente zeitliche Abstimmung bei der 
MIDI-Wiedergabe beibehalten.

Aufnehmen mit geringer Latenz 
mit virtuellen MIDI-Instrumenten 
und Verzögerungsausgleich
Wenn eine MIDI- oder Instrumentenspur, 
die MIDI-Daten an ein Instrumenten-Plug-In 
routet, scharfgeschaltet ist, setzt Pro Tools 
automatisch den Verzögerungsausgleich über die 
Hauptausgänge der Audiospur, des Auxiliary-
Eingangs oder der Instrumentenspur aus, auf 
denen das Instrumenten-Plug-In eingeschleift 
wird. Dies ermöglicht ein latenzfreies Abhören des 
Instrumenten-Plug-Ins während der Aufnahme.

Halten Sie die Befehls-, Ctrl- und 
Umschalttaste (Mac) bzw. die Strg-, 
Windows- und Umschalttaste (Windows) 
gedrückt und klicken Sie auf die Anzeige für 
den Spurausgleich, um die Low Latency 
Monitoring-Option für alle ausgewählten 
Spuren zu überschreiben.

Halten Sie die Befehls-, Wahl- und Ctrl-Taste 
(Mac) bzw. die Strg-, Alt- und Windows-
Taste (Windows) gedrückt und klicken Sie auf 
die Anzeige für den Spurausgleich, um die 
Low Latency Monitoring-Option für alle 
Spuren zu überschreiben. 

Wenn Instrumenten- oder MIDI-Spuren 
scharfgeschaltet sind, wird für alle 
Instrumenten- und Auxiliary-Eingangs-Spuren 
mit Instrumenten-Plug-In-Inserts, die für den 
MIDI-Empfang konfiguriert sind, der Modus 
mit geringer Latenz eingestellt. In diesem Fall 
zeigen die Anzeigen für den 
Verzögerungsausgleich für diese Spuren 0 an. 
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Plug-Ins für MIDI- und Audioverarbeitung

Bei einigen Audio verarbeitenden Plug-Ins (etwa 
Bruno und Reso) und vielen anderen Plug-Ins, 
können Verarbeitungsparameter während der 
Audioverarbeitung von den MIDI-Daten gesteuert 
werden. Beim Scharfschalten einer MIDI- oder 
Instrumentenspur, die ein Audio verarbeitendes 
Plug-In steuert, wechselt die Spur, auf der das 
Plug-In eingeschleift ist, in den Modus mit 
geringer Latenz. Dadurch wird das verarbeitete 
Audio früher abgespielt. Die Maßnahmen, mit 
denen dies verhindert und die zeitliche 
Abstimmung des Audios beibehalten werden 
kann, unterscheiden sich je nach der Art der Spur, 
auf der sich das Plug-In befindet. 

So erreichen Sie eine zeitliche Übereinstimmung 
von Audio bei Verwendung eines MIDI-gesteuerten 
Plug-Ins zur Aufnahme in einer Audiospur:

 Halten Sie die Windows- und Strg-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) gedrückt und klicken Sie auf die Anzeige 
für den Spurausgleich der Audiospur, um den 
Verzögerungsausgleich anzuwenden. 

So erreichen Sie eine zeitliche Übereinstimmung 
von Audio bei Verwendung eines MIDI-
gesteuerten Plug-Ins zur Aufnahme in einem 
Auxiliary-Eingang:

1 Halten Sie die Windows- und Strg-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) gedrückt und klicken Sie auf die Anzeige 
für den Spurausgleich des Auxiliary-Eingangs, 
um den Verzögerungsausgleich zu deaktivieren.

2 Geben Sie den Gesamtwert für die 
Systemverzögerung in das Feld für 
benutzerdefiniertes Offset ein.

Konfigurieren von Cue-
Mischungen mit 
Verzögerungsausgleich
Wenn Sie bereits eine Pro Tools-Session haben, 
die verschiedene Plug-In-Inserts und Mixer-
Routings verwendet, empfiehlt sich in der Regel 
die Aktivierung des Verzögerungsausgleichs. 
Wenn Sie die Overdubs mit einem Musiker 
aufnehmen möchten, müssen Sie die 
Abhörmischungen konfigurieren (Kopfhörer- oder 
Cue-Mischungen). 

Verwenden Sie Sends, um Cue-Mischungen 
an Audioausgangspfade für das Abhören durch 
den Musiker zu leiten. Leiten Sie neben der 
Hauptmischung, die im Control Room abgehört 
werden kann, auch Spur-Sends an einen oder 
mehrere Audioausgangspfade für das Abhören der 
Cue-Mischungen. Bei der Verwendung von Sends 
können Sie verschiedene Mischungen von der 
Hauptmischung für das Abhören von Cue-
Mischungen konfigurieren. Bei der Aufnahme 
eines Gitarristen möchte dieser sich etwa selbst 
mehr in der Cue-Mischung hören als Sie ihn in der 
Hauptmischung hören werden.

Der Verzögerungsausgleich für Instrumenten-
Plug-Ins funktioniert nur, wenn alle MIDI- 
und Audioverbindungen in Pro Tools 
stattfinden. Pro Tools hebt den 
Verzögerungsausgleich zwar nicht auf, wenn 
Sie ReWire zum Anschließen von Software-
Synthesizern und Samplern in anderen 
ReWire-Clientanwendungen (wie Reason) 
verwenden, Pro Tools kann aber nichts zur 
Latenz innerhalb des ReWire-Clients selbst 
beitragen.
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Beispielkonfiguration unter Verwendung von 
Sends für Cue-Mischungen:

1 Weisen Sie Ihren Hauptmischausgängen den 
Hauptausgang jeder Spur zu.

2 Weisen Sie einen Send (Mono oder Stereo) für 
jede Spur zu und legen Sie die Send-Ausgaben 
auf die Ausgabepfade 3 und 4 auf Ihrem Audio-
Interface.

3 Aktivieren Sie die FMP-Schaltfläche (Follow 
Main Pan) für alle Sends, sodass die Cue-
Mischung das gleiche Panning wie die 
Hauptmischung aufweist.

4 Legen Sie alle Sends auf Unity und Post-Fader 
fest. Dadurch können Sie die gleiche Mischung 
für den Musiker verwenden, aber auch dessen 
Signalstärke in der Cue-Mischung verstärken 
(oder abschwächen), indem Sie den Send-Pegel 
wie gewünscht anpassen.

5 Wählen Sie Track > New.

6 Geben Sie die Spurart (Main-Fader) und das 
Format (Stereo) an und klicken Sie auf Create.

7 Wählen Sie im Output Path-Selektor der 
Master-Fader-Spur die Ausgabepfade 3 und 4 
zum Abhören der Mischung. 

8 Passen Sie den Fader der Master-Fader-Spur an, 
um die Lautstärke für die Cue-Mischung zu 
steuern.

9 Wiederholen Sie bei Bedarf die vorangehenden 
Schritte für weitere Cue-Mischungen auf 
zusätzlichen Ausgängen auf Ihrem Audio-
Interface.

Einstellen eines Hardware-
Insert-Verzögerungs-Offsets
Um Verzögerungen (Latenz) von externen 
Hardwaregeräten (etwa einem Effektgerät), die Sie 
in Ihrer Session verwenden, auszugleichen, 
können Sie den Wert für den Hardware-Insert-
Verzögerungsausgleich (in Millisekunden) für 
jedes externe Gerät manuell im I/O Setup-
Dialogfeld einstellen. Diese Latenzzeiten werden 
von der Delay Compensation Engine dazu 
verwendet, bei Einsatz eines Hardware-Inserts und 
aktiviertem Verzögerungsausgleich die 
Eingangspfade zeitlich abzustimmen.

So richten Sie ein Insert-Verzögerungs-Offset ein:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die H/W Insert Delay-
Registerkarte.

3 Geben Sie in das Feld, das dem Eingang mit 
dem angeschlossenen Hardware-Insert 
entspricht, einen Wert in Millisekunden ein.

Es wird empfohlen, bei aktiviertem 
Verzögerungsausgleich keine Auxiliary-
Eingangs- oder Master-Fader-Spuren 
einzuschleifen, die Sie zum Steuern der 
Lautstärke der Cue-Mischung verwenden. 
Auch für andere aufgenommene Spuren 
sollten Sie dies vermeiden. (Einige Inserts 
mit niedriger Latenz sind abhängig von den 
Vorlieben des Musikers möglich.)

Insert-Verzögerungs-Offsets haben nur dann 
eine Auswirkung, wenn der I/O für 
Hardware-Inserts verwendet wird.
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Ermitteln der Verzögerung des 
Hardware-Inserts
Gehen Sie die Dokumentation Ihres externen 
Hardwaregeräts durch, um zu sehen, ob die 
Latenzzeit angegeben ist. Sie können die 
Verzögerungszeit für Hardware-Inserts auch anhand 
folgender Schritte in Pro Tools bestimmen.

So bestimmen Sie die Verzögerung für Hardware-
Inserts:

1 Stellen Sie sicher, dass die Automatic Delay 

Compensation-Option aktiviert ist (Options > 

Delay Compensation).

2 Ändern Sie die Haupt-Zeitskala Ihrer Session 
auf „Min:Sec“.

3 Erstellen Sie zwei neue Spuren. 

4 Positionieren Sie eine kurze Note (oder einen 
anderen Sound mit einem unverkennbaren 
Beginn) auf Spur 1.

5 Schleifen Sie das HW-Insert auf Spur 1 ein. 

6 Stellen Sie sicher, dass nur das Dry-Signal über 
das Gerät geleitet wird. 

7 Leiten Sie den Output von Spur 1 über Busse zu 
dem Output von Spur 2. 

8 Bereiten Sie Spur 2 mit „Record Enable“ auf die 
Aufnahme vor und wählen Sie im Transport-
Fenster die Record Enable and Play-Option aus. 
So können Sie das Audiomaterial auf Spur 1 
wiedergeben und es auf Spur 2 aufnehmen.

9 Zoomen Sie nach der Aufnahme heran und 
vergleichen Sie die unterschiedlichen 
Startzeiten des Audios in Spur 1 und Spur 2. 
Diese Differenz ergibt den Wert, den Sie als 
Verzögerungs-Offset für den Hardware-Insert 
eingeben können.

Dither
Dithering wird zum Reduzieren von 
Quantisierungsartefakten beim Reduzieren der 
Bitrate eines Ausgangssignals verwendet, 
beispielsweise von 24 Bit auf 16 Bit. 
Quantisierungsartefakte sind besonders auffällig, 
wenn sich ein Audiosignal im niedrigen Bereich 
der Signaldynamik befindet, wie beispielsweise 
bei leisen Passagen oder beim Fade-Out.

Dithering reduziert Quantisierungsartefakte durch 
Einfügung eines sehr leisen Rauschens in ein 
Signal, wodurch die Verzerrung geglättet wird, die 
beim Verringern der Bitrate eines Signals 
entstehen kann. 

Beim Dithering muss zwischen Signal-Rausch-
Verhalten und weniger offensichtlicher 
Verzerrung abgewogen werden. Durch richtige 
Anwendung von Dithering erhalten Sie eine 
bessere subjektive Leistung, wenn Sie die Bitrate 
von Audio reduzieren. 

Dithering in Pro Tools
Dithering kann in Pro Tools auf verschiedene 
Arten eingesetzt werden. Jede davon hat einen 
bestimmten Zweck innerhalb der Vielzahl von 
Arbeitsschritten, bei denen Dithering von Vorteil 
sein könnte. 

Dither-Plug-Ins für den Mixdown – wenn Sie 
abmischen oder auf die Festplatte bouncen und 
Ihre Zielbitrate unter 24 Bit liegt, fügen Sie ein 
Dither-Plug-In auf einem Master-Fader ein, 
das die Ausgangsmischung steuert. Sie können 
Echtzeit-Dither-Plug-Ins von Avid oder anderen 
Herstellern verwenden. 
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Wichtige Informationen zum Dithering beim 
Mixdown oder Bouncen auf die Festplatte finden 
Sie unter „Verwenden von Dither“ auf Seite 1138.

Dithering beim Exportieren und Importieren – 
wenn Sie Audio auf eine geringere Bitrate 
exportieren oder eine Audiodatei in eine Session 
importieren, die eine geringere Bitrate als die 
Datei aufweist, wird ein voreingestellter, 
rauschgeformter Dither angewendet.

Rauschformung
Rauschformung kann die Audioleistung weiter 
verbessern und das wahrnehmbare Rauschen 
in mit Dither behandeltem Audiomaterial 
verringern. Bei der Rauschformung wird gefiltert, 
um das Rauschen von Frequenzen in der Mitte des 
Audiospektrums (etwa 4 kHz) zu verschieben, wo 
das menschliche Gehör am empfindlichsten ist.

Rauschformung ist in den Dither- und POW-r 
Dither-Plug-Ins verfügbar. 

Verwenden einer Ethernet-
Bedienoberfläche mit 
Pro Tools
Avid bietet mehrere Ethernet-basierte 
Bedienoberflächen für Pro Tools.

D-Control und D-Command (nur Pro Tools HD)

D-Control- und D-Command sind 
Bedienoberflächen für die Direktsteuerung 
und Teil von ICON, einem flexiblen, integrierten 
System, das die Funktionalität von Pro Tools 
erweitert. 

C|24

C|24 ist eine spezielle Bedienoberfläche mit Zugriff 
auf fast alle Pro Tools-Funktionen zum Aufnehmen, 
Mischen, Editieren, Signal-Routing, zur Plug-In-
Steuerung und für Automationsfunktionen. 

EUCON

Pro Tools unterstützt Avid-Bedienoberflächen, 
die EUCON-Steuerung (Extended User 
Control) verwenden (siehe Pro Tools-EUCON-
Handbuch). EUCON ist ein von Avid entwickeltes 
innovatives Highspeed-Ethernet-Protokoll, das 
Bedienoberflächen der Avid-Hardware die direkte 
Kommunikation mit Softwareanwendungen 
(etwa Pro Tools) ermöglicht.

Weitere Informationen zu Dither-Plug-Ins 
finden Sie im Audio-Plug-Ins-Handbuch.

Weitere Informationen über die Anwendung 
von Dithering beim Exportieren finden Sie 
unter „Exportieren von Audio“ auf Seite 340. 

Weitere Informationen über die Anwendung 
von Dithering beim Importieren finden Sie 
unter „Konvertierung der Bitrate und 
Dithering“ auf Seite 328. 

Weitere Informationen über Rauschformung 
finden Sie im Audio-Plug-Ins-Handbuch.
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Aktivieren einer Ethernet-
Bedienoberfläche mit Pro Tools

So aktivieren Sie eine Ethernet-Bedienoberfläche 
mit Pro Tools:

1 Wählen Sie Setup > Peripherals und 
anschließend die Ethernet Controllers-
Registerkarte.

2 Wählen Sie Enable. 

3 Wenn Ihre Ethernet-Bedienoberfläche mehr als 
ein Gerät umfasst, wählen Sie die Geräte in 
numerischer Reihenfolge so aus, wie sie von 
links nach rechts angeordnet werden sollen. 

4 Klicken Sie auf OK.

So aktivieren Sie die EUCON-Steuerung in 
Pro Tools:

1 Wählen Sie Setup > Peripherals.

2 Klicken Sie auf die Ethernet Controllers-
Registerkarte.

3 Wählen Sie die EUCON-Option.

4 Klicken Sie auf OK.

Ist die EUCON-Option ausgewählt, ist Pro Tools 
für die Steuerung durch einen oder mehrere 
EUCON-kompatible Controller aktiviert.

Verwenden einer MIDI-
Bedienoberfläche mit 
Pro Tools
Mit MIDI-Bedienoberflächen können Sie die 
Steuerung vieler Pro Tools-Funktionen 
verbessern, indem Sie Fader und Regler anpassen, 
Transport-Einstellungen aktivieren oder Plug-In-
Parameter bearbeiten. 

Command|8

Command|8 ist die kompakte, USB-basierte 
MIDI-Bedienoberfläche für Pro Tools-Systeme. 

Andere MIDI-Bedienoberflächen

Pro Tools unterstützt einige MIDI-
Bedienoberflächen, die HUI-Controller-
Personalities unterstützen.

Personality-Dateien für MIDI-
Bedienoberflächen
MIDI Control Surface Personalities sind Dateien, 
die Pro Tools die Kommunikation mit der MIDI-
Bedienoberfläche ermöglichen. Wenn Sie 
Pro Tools installieren, werden diese Dateien 
standardmäßig im Controllers-Ordner im 
Pro Tools-Anwendungsordner installiert. Sind die 
Dateien nicht vorhanden, führen Sie das 
Pro Tools-Installationsprogramm aus, um die 
Personality-Dateien zu installieren.

Weitere Informationen finden Sie in der 
Dokumentation Ihrer Ethernet-
Bedienoberfläche.

Weitere Informationen zur Verwendung von 
Pro Tools mit EUCON erhalten Sie im 
Pro Tools-EUCON-Handbuch.

Vollständige Anleitungen zum 
Anschließen und Konfigurieren von 
Command|8 finden Sie im Command|8-
Handbuch.
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Anschließen einer MIDI-
Bedienoberfläche
Wenn Ihre Pro Tools-Hardware über MIDI-
Anschlüsse verfügt, können Sie eine MIDI-
Bedienoberfläche direkt mit Ihrem System 
verbinden. Falls nicht, müssen Sie ein MIDI-
Interface verwenden. USB-MIDI-
Bedienoberflächen (etwa Command|8) und 
FireWire-Bedienoberflächen (etwa 003) erfordern 
keine zusätzliche MIDI-Verbindung zu Ihrem 
Computer.

So schließen Sie eine MIDI-Bedienoberfläche 
(ohne USB und FireWire) an:

1 Verbinden Sie den MIDI Out-Anschluss Ihrer 
MIDI-Bedienoberfläche mit einem 5-poligen 
MIDI-Standardkabel mit dem MIDI In-
Anschluss Ihrer Pro Tools-Hardware oder Ihres 
MIDI-Interface.

2 Verbinden Sie den MIDI In-Anschluss Ihrer 
MIDI-Bedienoberfläche über ein 5-poliges 
MIDI-Standardkabel mit dem MIDI Out-
Anschluss Ihrer Pro Tools-Hardware oder Ihres 
MIDI-Interface.

3 Wenn Ihr MIDI-Interface über mehrere 
Anschlüsse verfügt, notieren Sie sich, 
an welchen MIDI-Anschluss die 
Bedienoberfläche angeschlossen ist.

Konfigurieren Ihres Systems für 
eine MIDI-Bedienoberfläche
Eine MIDI-Bedienoberfläche wird auf die gleiche 
Weise konfiguriert wie jedes andere MIDI-Gerät 
in Pro Tools, und zwar über MIDI Studio Setup 
(Windows) oder Audio MIDI Setup (Mac).

Aktivieren einer MIDI-
Bedienoberfläche mit Pro Tools

So aktivieren Sie eine MIDI-Bedienoberfläche mit 
Pro Tools:

1 Wählen Sie Setup > Peripherals und 
anschließend die MIDI Controllers-
Registerkarte.

2 Wählen Sie den Gerätenamen Ihrer MIDI-
Bedienoberfläche aus dem Type-Popup-Menü.

3 Wählen Sie den Quellanschluss der MIDI-
Bedienoberfläche aus dem Receive From-
Popup-Menü.

4 Wählen Sie einen Zielanschluss aus dem Send 

To-Popup-Menü.

5 Wenn Ihre MIDI-Bedienoberfläche über mehr 
als acht Kanalzüge verfügt oder Sie mehrere 
Geräte desselben Typs in Serie verwenden, 
wählen Sie die entsprechende Anzahl an 
Kanalzügen aus dem Popup-Menü unter #Ch's.

6 Klicken Sie auf OK.

Sie können weitere MIDI-Bedienoberflächen 
(insgesamt vier) hinzufügen, indem Sie die obigen 
Schritte wiederholen. Stellen Sie sicher, dass keine 
der Bedienoberflächen im Pro Tools Peripherals-
Dialogfeld denselben MIDI-Quell- und 
Zielanschlüssen oder -kanälen zugeordnet wird. 

Vollständige Anleitungen zum Konfigurieren 
Ihres MIDI-Studios finden Sie im 
Benutzerhandbuch Ihres Systems.
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Aktivieren der MIDI-
Bedienoberfläche als 
Eingabegerät
Sie müssen sicherstellen, dass die MIDI-
Bedienoberfläche in Pro Tools als Eingabegerät 
aktiviert ist.

So aktivieren Sie eine MIDI-Bedienoberfläche als 
Eingabegerät:

1 Wählen Sie Setup > MIDI > Input Devices.

2 Wählen Sie den Quellanschluss aus, den Sie im 
Receive From-Popup-Menü auf der MIDI 
Controllers-Seite des Peripherals-Dialogfelds 
ausgewählt haben. 

3 Klicken Sie auf OK.

Wenn Sie nicht möchten, dass MIDI-Daten von 
der Bedienoberfläche in Pro Tools ankommen, 
können Sie den Quellanschluss im MIDI Input 
Enable-Fenster deaktivieren.
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Kapitel 44: Plug-In- und Hardware-Inserts

Ein Pro Tools-Insert routet das Signal von der 
Spur auf einen externen Effekt Ihrer Wahl und 
führt es automatisch zur selben Spur zurück. 
Inserts verändern die ursprünglichen Audiodateien 
nicht, sondern verarbeiten Audio während der 
Wiedergabe in Echtzeit. Sie können 
Echtzeiteffekte dauerhaft auf Spuren anwenden, 
indem Sie den jeweiligen Effekt aufnehmen oder 
auf Festplatte bouncen (weitere Informationen 
finden Sie unter Kapitel 46: „Mixdown“).

Pro Tools bietet auf jeder Audio-, Auxiliary-
Eingangs-, Master-Fader- und Instrumentenspur 
bis zu zehn Unity-Gain-Inserts. Inserts auf Audio-, 
Auxiliary-Eingangs- und Instrumentenspuren sind 
Pre-Fader, auf Master-Fader-Spuren hingegen 
ausschließlich Post-Fader.

Wenn mehr als ein Plug-In oder Hardware-Insert 
auf einer Spur verwendet wird, werden die Inserts 
nacheinander bearbeitet. Jeder Effekt wird zu dem 
des jeweils vorhergehenden Inserts hinzugefügt 
(von oben nach unten im Inserts
-Bedienfeld des Mix-Fensters und von links nach 
rechts im Inserts-Bedienfeld des Edit-Fensters).

Inserts auf Audio-, Auxiliary-Eingangs- und 
Instrumentenspuren sind Pre-Fader. 
Übersteuerung (Clipping) entsteht, wenn Sie die 
Verstärkung extrem hochdrehen, besonders auf 
Spuren, die bei hoher Amplitude aufgenommen 
wurden. Achten Sie in der Pegelanzeige des 
Bildschirms auf etwaige Übersteuerung. (Inserts 
auf Master-Fadern sind Post-Fader-Inserts.)

Inserttypen
Ein Insert kann entweder ein Software-DSP-Plug-
In oder ein Hardware-Insert sein. 

Plug-In-Inserts
Plug-In-Inserts sind Software-Inserts, 
die Audiomaterial auf einer Spur in Echtzeit 
verarbeiten. Die EQ-, Compressor- und Delay-
Plug-Ins in Ihrem Pro Tools-System können etwa 
als Echtzeit-Plug-In-Inserts verwendet werden.

Zusätzliche Echtzeit-Plug-Ins sind bei Avid und 
vielen anderen Herstellern erhältlich. 

Insert-Schaltfläche und Insert-Selektor in der Spur

Insert-Schaltfläche

Insert-Selektor

Weitere Informationen zu den in Ihrem 
Pro Tools-System enthaltenen Plug-Ins 
finden Sie im Audio-Plug-Ins-Handbuch.

Weitere Informationen zu optionalen 
Plug-Ins finden Sie unter www.avid.com.
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Hardware-I/O-Inserts
Hardware-I/O-Inserts können Audiosignale durch 
ein externes Gerät routen, das mit den parallelen Ein- 
und Ausgängen eines Audio-Interface verbunden ist. 
Sie können das Audiomaterial auf einer Spur mit 
einem Hardware-Insert in Echtzeit bearbeiten.
 

Insert-Pfade benötigen Audio-Interface-Ein- und -
Ausgänge und werden durch die I/O Setup-
Konfiguration Ihres Systems bestimmt.

Verwenden von Inserts zur 
Effektbearbeitung 
Inserts können folgendermaßen verwendet werden: 

Auf einzelnen Spuren. – Inserts können auf 
einzelne Audio-, Auxiliary-Eingangs-, Master-
Fader- oder Instrumentenspuren angewendet werden.

Bei Inline-Inserts regeln Sie den Effektanteil, indem 
Sie die Balance-(bzw. Wet/Dry-)Einstellungen des 
Plug-Ins oder externen Geräts anpassen.

Als gemeinsame Ressourcen. – ein Insert kann in 
einer Send-Return-Anordnung als gemeinsam 
genutzte Ressource verwendet werden. Dazu werden 
Signale von mehreren Spuren zu einem Aux-Eingang 
geleitet und der Insert wird auf diese Spur 
angewendet. Anschließend können Sie den Send-
Pegel für jede Spur steuern und den Gesamtpegel des 
Effekts von der Auxiliary-Eingangs-Spur aus regeln. 
Durch das Verwenden von Sends und anderen 
Routing-Funktionen maximieren Sie die 
Verarbeitungsleistung Ihres Systems. 

Insert-Formate
Mono-Inserts. – werden auf Monospuren 
verwendet. Alle auf einer Spur nach einem Stereo-
Insert angewendeten Inserts werden automatisch 
als Stereo-Inserts verwendet.

Stereo-Inserts. – werden auf Stereospuren 
verwendet. Ein Stereo-Hardware-I/O-Insert sendet 
das Signal an einen Eingangs-/Ausgangspfad.

Mono In/Stereo Out-Plug-In-Inserts. – leiten einen 
Stereoeffekt von einer Monoquelle zurück. 
Mit bestimmten Plug-Ins (etwa D-Verb) können 
Sie Stereoausgangssignale aus einem Monokanal 
erzeugen. Eine auf diese Weise erzeugte Stereospur 
verfügt über Panning-Steuerelemente für jeden 
Kanal des Stereosignals. Alle Inserts auf einer 
Spur, die nach einem Stereo-Insert angewendet 
werden, funktionieren automatisch in Stereo.

Multimono-Plug-In-Inserts. – werden auf Stereo- 
oder Mehrkanalspuren verwendet, wenn keine 
Mehrkanalversion des Plug-Ins verfügbar ist. 
Die Steuerelemente für alle Kanäle sind 
standardmäßig gekoppelt, sodass sie sich 
zusammen anpassen lassen. Sie können die 
Koppelung der Steuerelemente mithilfe der Master 
Link-Schaltfläche lösen, um sie unabhängig 
voneinander anpassen zu können. Siehe „Koppeln 
der Steuerelemente von Multimono-Plug-Ins und 
Aufheben der Koppelung“ auf Seite 1067.

Mehrkanal-Plug-In-Inserts. – werden auf Stereo- 
und Mehrkanalspuren verwendet. Auf 
Mehrkanalspuren sind die Steuerelemente für alle 
Kanäle im Allgemeinen miteinander verknüpft.

Hardware-I/O-Insert

Beispiele für Send-/Return-Busse und andere 
Setups für Submixe finden Sie unter „Signal-
Routing zum Abhören und Erstellen von 
Submixes“ auf Seite 1014. 

Beim erneuten Koppeln können die 
Automationsdaten verloren gehen. Siehe 
„Koppeln der Steuerelemente von 
Multimono-Plug-Ins und Aufheben der 
Koppelung“ auf Seite 1067
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Plug-In-Formate
Es gibt drei von Pro Tools unterstützte Plug-In-
Formate (DSP, Native und AudioSuite), von denen 
zwei als Echtzeit-Inserts eingesetzt werden können:

DSP-Plug-Ins. – bieten DSP-Leistung für die 
Echtzeit-Plug-In-Bearbeitung ausschließlich in 
Pro Tools|HDX-Systemen.

Native-Plug-Ins. – bieten Echtzeit-Plug-In-
Verarbeitung in hostbasierten Systemen.

AudioSuite-Plug-Ins. – bieten dateibasierte Plug-
Ins (nicht in Echtzeit, gerendert) für Pro Tools.

Abhängig von der verwendeten Pro Tools-
Software können Echtzeit-Plug-Ins wie folgt 
verwendet werden:

Pro Tools|HDX-Systeme

DSP und Native-Plug-Ins können auf Audio-, 
Auxiliary-Eingangs-, Master-Fader- und 
Instrumentenspuren verwendet werden.

Hostbasierte Pro Tools-Systeme

Native-Plug-Ins können auf Audio-, Auxiliary-
Eingangs-, Master-Fader- und Instrumentenspuren 
verwendet werden. 

Voice-Auslastung und 
Gesamtlatenz für native 
(hostbasierte) Plug-Ins
(Nur Pro Tools|HDX-Systeme)

Bei Pro Tools|HDX-Systemen kann das erste 
Einschleifen eines (hostbasierten) Native-Plug-Ins 
zu zusätzlicher Latenz führen, und es werden pro 
Kanal zwei zusätzliche Voices (1 Voice für den 
Eingang, 1 Voice für den Ausgang) verwendet, 
wenn die folgenden Bedingungen erfüllt sind:

• Beim Einschleifen in einer Auxiliary-Eingangs- 
oder Master-Fader-Spur 

• Beim Einschleifen in einer Instrumentenspur, 
die kein Instrumenten-Plug-In enthält

• Beim Einschleifen in einer beliebigen Spur 
hinter einem DSP-Plug-In

Beispiel: Beim ersten Einschleifen eines hostbasierten 
Plug-Ins in eine Mono-Auxiliary-Eingangs-Spur 
werden zwei Voices gebraucht (ein Kanal mit zwei 
Voices). Beim ersten Einschleifen dieses Plug-Ins in 
eine Stereo-Auxiliary-Eingangs-Spur werden vier 
Voices verwendet (zwei Kanäle mit je zwei Voices).

Entsprechend benötigen hostbasierte Plug-Ins auf 
derselben Spur keine zusätzlichen Voices, es sei 
denn, ein DSP-Plug-In wird zwischen anderen 
hostbasierten Plug-Ins eingeschleift. 

Bei der Verwendung von Voices für hostbasierte 
Plug-Ins auf Spuren wird in jedem der folgenden 
Fälle eine zusätzliche Voice verwendet:

• Bei Verwendung der externen Key-Sidechain 
eines hostbasierten Plug-Ins auf dieser Spur

• Bei Auswahl mehrerer Spurenausgänge für 
diese Spur (eine Voice für jeden Ausgang)

• Bei Auswahl von „AFL/PFL Path“ auf der 
Output-Registerkarte des Dialogfelds 
„I/O Setup“ (eine Voice für jeden Kanal)

Informationen zur Verwendung der 
AudioSuite-Plug-Ins in Pro Tools finden Sie 
unter Kapitel 39: „AudioSuite“.

Bei Avid HDX-Systemen verwenden Native-
Plug-Ins, die auf Auxiliary-Eingangs-, Master-
Fader- und Instrumentenspuren eingeschleift 
wurden, zusätzliche Voices und können 
abhängig von der Hardware-Puffergröße 
zusätzliche Latenz hervorrufen. Siehe „Voice-
Auslastung und Gesamtlatenz für native 
(hostbasierte) Plug-Ins“ auf Seite 1039. 

Tipps zur Maximierung der Leistung 
nativer Plug-Ins finden Sie unter 
„Konfigurieren der Pro Tools-
Systemeinstellungen“ auf Seite 52.

Vermeiden Sie es möglichst auf allen Spuren, 
DSP-Plug-Ins zwischen (hostbasierten) 
Native-Plug-Ins einzuschleifen. Dadurch 
werden unnötigerweise zusätzliche Voices 
beansprucht und es kann zusätzliche Latenz 
verursacht werden.
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Anzeigen von Inserts
Sie können sowohl das Mix- als auch das Edit-
Fenster so konfigurieren, dass die Inserts A–E und 
F–J entweder ein- oder ausgeblendet werden. 
Plug-In-Fenster bieten vollständigen Zugriff auf 
Plug-In-Steuerelemente. 

Führen Sie zum Einblenden (oder Ausblenden) 
von Inserts einen der folgenden Schritte durch:

 Wählen Sie im Mix-Fenster (oder Edit-Fenster) 
View > Mix Window (bzw. Edit Window) > 
Inserts A–E oder Inserts F–J.

 Wählen Sie im View-Selektor des Mix- oder 
Edit-Fenster Inserts A–E oder Inserts F–J.

Anzeigen des Plug-In-
Fensterstatus
In den Mix- und Edit-Fenstern werden über die 
Plug-In-Schaltfläche und den Plug-In-Selektor das 
aktuell eingeschleifte Plug-In, dessen Bypass-
Status (siehe „Bypass-Schaltung von Plug-Ins“ auf 
Seite 1065), Fokus-Status und Fensterstatus 
angezeigt.

Kennzeichnung des Controller-Fokus

Bei den meisten Bedienoberflächen kann nur ein 
Plug-In gleichzeitig im Fokus stehen. Bei ICON-
Bedienoberflächen können bis zu vier Plug-Ins 
gleichzeitig im Fokus stehen (mit den EQ- und 
Dynamics-Bedienelementen und Custom Faders 
auf Ihrer Bedienoberfläche).

Der aktuelle Controller-Fokus, sofern vorhanden, 
wird durch farbige Umrahmung des Namens 
gekennzeichnet:

Inserts und Sends im Mix-Fenster

Inserts (A–E)-Bedienfeld

Sends (A–E)-Bedienfeld

I/O-Bedienfeld

Sends (F–J)-Bedienfeld

Inserts (F–J)-Bedienfeld

Leuchtende Plug-In-Anzeige kennzeichnet offenes 
Plug-In-Fenster

Controller-Fokus
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Deaktivieren von Inserts
Sie können Plug-In- und Hardware-Inserts 
deaktivieren, um ihre Ressourcen für andere Zwecke 
freizugeben. Inaktive Plug-In-Inserts behalten ihre 
Zuweisung, Position und Automations-Playlists bei. 
Es verarbeitet dann jedoch kein Audio und nimmt 
keine DSP-Ressourcen in Anspruch.

Beim Öffnen von Sessions können Inserts in 
folgenden Fällen automatisch deaktiviert werden:

• Die DSP-Ressourcen des Systems sind 
unzureichend.

• Ein Plug-In ist nicht installiert.

• Ein Plug-In-Typ ist nicht verfügbar.

• Beim Öffnen der Session werden Plug-In-Typen 
ersetzt. Dazu kann es kommen, wenn der Typ 
verfügbar ist, aber das Ersetzen zu einem nicht 
unterstützten Zustand führen würde, etwa beim 
Öffnen einer Session mit einem DSP-basierten 
Plug-In, für das keine hostbasierte Version 
verfügbar ist.

Führen Sie zum Deaktivieren eines Inserts einen 
der folgenden Schritte durch:

 Halten Sie die Strg- und Windows-Taste 
(Windows) bzw. die Befehls- und Ctrl-Taste 
(Mac) gedrückt und klicken Sie auf die Insert-
Schaltfläche.

 Klicken Sie mit der rechten Maustaste auf 
die Insert-Schaltfläche und wählen Sie Make 
Inactive.

 Deaktivieren Sie die Spur. Siehe „Deaktivieren 
von Spuren“ auf Seite 249.

So aktivieren oder deaktivieren Sie Inserts an 
derselben Position auf allen Spuren:

 Halten Sie die Strg-, Windows- und Alt-Taste 
(Windows) bzw. die Befehls-, Ctrl- und Wahltaste 
(Mac) gedrückt und klicken Sie an der Position, 
an der Sie die Inserts aktivieren oder deaktivieren 
möchten, auf eine Insert-Schaltfläche.

So aktivieren oder deaktivieren Sie Inserts an 
derselben Position auf allen selektierten Spuren:

 Halten Sie die Strg-, Windows-, Alt- und 
Umschalttaste (Windows) bzw. die Befehls-, 
Ctrl-, Wahl- und Umschalttaste (Mac) gedrückt 
und klicken Sie an der Position, an der Sie die 
Inserts aktivieren oder deaktivieren möchten, 
auf eine Insert-Schaltfläche.

Inaktive Plug-In-Inserts 

Alle mit inaktiven Plug-In-Inserts verknüpften 
Automations-Playlists bleiben erhalten. Außerdem 
haben alle in der Session ausgeführten 
Bearbeitungsschritte Auswirkungen auf die 
Automations-Playlists der Plug-Ins. 
Automationsdaten für ein inaktives Plug-In 
können nicht aufgenommen und Plug-In-
Steuerelemente nicht angepasst werden. 

Anzeige inaktiver Plug-Ins

Fenster mit Anzeige eines inaktiven Plug-Ins

 
Inaktiv
(kursiv)

Aktiv
(unformatierter Text)
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Inaktive Hardware-Inserts

Inaktive Hardware-Inserts behalten ihre 
Zuweisungen bei, übertragen aber keine 
Audiosignale und verbrauchen keine DSP-
Ressourcen.

Einschleifen von Plug-Ins auf 
Spuren
Zur Verwendung eines Echtzeit-Plug-Ins müssen 
Sie es auf einer Spur einschleifen. 

So schleifen Sie ein Plug-In in eine Spur ein:

1 Stellen Sie sicher, dass das Inserts-Bedienfeld 
(A–E oder F–J) im Mix- oder Edit-Fenster 
angezeigt wird.

2 Klicken Sie auf den Insert-Selektor der Spur 
und wählen Sie das gewünschte Plug-In aus. 
(Weitere Informationen finden Sie unter „Plug-
In-Formate“ auf Seite 1039.)

So entfernen Sie einen Insert aus einer Spur:

 Klicken Sie auf den Insert-Selektor und wählen 
Sie No Insert.

Anordnen von nativen und DSP-
Plug-Ins auf Audiospuren
(Nur Pro Tools|HDX-Systeme)

Werden auf Pro Tools|HDX-Systemen Native- 
und DSP-Plug-Ins auf einer Audio-, Auxiliary-
Eingangs- oder Master-Fader-Spur kombiniert, 
kann die Reihenfolge, in der sie eingeschleift 
werden, unterschiedliche Ergebnisse bewirken:

Native Plug-Ins als Gruppe vor DSP-Plug-Ins. – 
es werden keine zusätzlichen Voices benötigt und 
es tritt keine Verarbeitungslatenz auf. Native Plug-
Ins werden auf Bypass geschaltet, wenn für diese 
Spur „Record Enable“ oder TrackInput-
Monitoring aktiviert ist. 

Native Plug-Ins als Gruppe nach DSP-Plug-Ins. – 
bei jedem erstmaligen Einschleifen eines nativen 
Plug-Ins nach einem DSP-Plug-In in einer Spur tritt 
Verarbeitungslatenz auf und es werden zusätzliche 
Voices verwendet (siehe „Voice-Auslastung und 
Gesamtlatenz für native (hostbasierte) Plug-Ins“ 
auf Seite 1039). Native Plug-Ins bleiben aktiviert, 
wenn für diese Spur „Record Enable“ oder 
TrackInput-Monitoring aktiviert ist. 

Für Hardware-Inserts gibt es keine Bypass-
Steuerelemente. Sie können die Funktion zum 
Deaktivieren immer verwenden, wenn Sie 
einen Hardware-Insert stumm oder auf 
Bypass schalten wollen. 

Plug-Ins können nicht während der 
Aufnahme eingeschleift oder entfernt 
werden.

Einschleifen eines DSP-Plug-Ins

Sie können ein Plug-In in eine Spur 
einschleifen, indem Sie eine der zugehörigen 
Plug-In-Einstellungsdateien (.txf) aus einem 
Workspace-Browser an eine verfügbare 
Insert-Position der Spur im Mix-Fenster 
ziehen. Siehe „Drag & Drop von Plug-In-
Einstellungsdateien“ auf Seite 1058. 

Gruppieren Sie Plug-Ins desselben Typs 
grundlegend zusammen, besonders wenn Sie 
native Plug-Ins nach DSP-Plug-Ins 
einschleifen. Sonst werden zusätzliche Voices 
evtl. unnötigerweise verwendet.



Kapitel 44: Plug-In- und Hardware-Inserts 1043

Empfehlungen für das Anordnen

Wählen Sie je nach Ihren Bedürfnissen eine der 
folgenden Vorgehensweisen, wenn Sie native und 
DSP-Plug-Ins auf einer Audiospur kombinieren:

• Ordnen Sie alle DSP-Plug-Ins vor nativen Plug-
Ins an, um sicherzustellen, dass native Plug-Ins 
aktiviert bleiben, wenn Sie eine Spur 
scharfschalten oder TrackInput-Monitoring 
verwenden.

• Ordnen Sie alle nativen Plug-Ins vor DSP-Plug-
Ins an, um Voices beizubehalten und die 
Verarbeitungslatenz so niedrig wie möglich 
zu halten.

Unterteilung des Plug-In-
Menüs
In Pro Tools können Sie festlegen, wie Plug-In-
Listen (Plug-In-Menüs) im Insert-Selektor und im 
Plug-In-Selektor angeordnet sind. 

Wählen Sie in Pro Tools auf der Display Preferences-
Registerkarte im Popup-Menü Organize Plug-In 
Menus By aus, ob die Plug-Ins in den Plug-In-Menüs 
als alphabetische Liste ohne Unterteilung (Flat List) 
angezeigt oder nach Kategorie (Category), nach 
Hersteller (Manufacturer) oder nach Kategorie 
und Hersteller (Category and Manufacturer) sortiert 
werden sollen. 

Unterstützung der Bedienoberfläche

Bedienoberflächen mit mehrfarbigen LCDs (etwa 
D-Control) zeigen Plug-Ins wie folgt an:

• Plug-In-Kategorien (etwa EQ) und Plug-In-
Hersteller (etwa Aphex) werden in Gelb 
(Bernstein) angezeigt.

• Spezifische Plug-Ins, die sich in den Plug-In-
Unterordnern befinden (etwa EQ III im EQ-
Unterordner), werden in Grün angezeigt.

Bedienoberflächen mit einfarbigen Displays (etwa 
Command|8) zeigen keine Plug-In-Auswahl. Sie 
zeigen den Inhalt eines Plug-In-Ordners als Liste an.

Organize Plug-In Menus By-
Einstellung
Flat List. – zeigt die Plug-Ins in einer einzigen 
Liste in alphabetischer Reihenfolge an.

Category. – organisiert die Plug-Ins nach 
Bearbeitungskategorie (wie etwa „EQ“, 
„Dynamics“ oder „Delay“). Dabei werden die 
einzelnen Plug-Ins in den Untermenüs für die 
Kategorien aufgeführt. Plug-Ins, die sich keiner 
Standardkategorie zuordnen lassen (wie etwa 
Signal Generator), oder Plug-Ins anderer 
Hersteller, denen vom jeweiligen Hersteller keine 
Kategorie zugeordnet wurde, werden der Other-
Kategorie unterstellt. Plug-Ins können mehr als 
einer Kategorie angehören. 

Es gibt folgende Plug-In-Kategorien in Pro Tools:

• EQ

• Dynamics

• Pitch Shift

• Reverb

• Delay

• Modulation

• Harmonic

• Noise Reduction

• Dither

• Sound Field

• Instrument

• Other

• Effects

Im Effects-Unterordner werden Spezialeffekte, 
Mehrfacheffekte und andere Plug-Ins verwaltet. 
Alle Plug-Ins, für die die Plug-In-Kategorie 
„Effects“ definiert wurden, werden im Effects-
Unterordner angezeigt.

Wenn für eine Kategorie keine Plug-Ins im 
System installiert wurden, wird der 
entsprechende Unterordner nicht angezeigt.
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Manufacturer. – organisiert die Plug-Ins nach dem 
Hersteller. Dabei werden die einzelnen Plug-Ins in 
den Untermenüs für die Hersteller aufgeführt. Plug-
Ins, für die kein Hersteller festgelegt ist, werden im 
Other-Ordner für die Hersteller aufgeführt. 

Category and Manufacturer. – organisiert Plug-
Ins in zwei Menüebenen. In der oberen 
Menüebene werden die Plug-Ins nach 
Bearbeitungskategorie (wie etwa „EQ“, 
„Dynamics“ oder „Delay“) angezeigt. Dabei 
werden die einzelnen Plug-Ins in den Untermenüs 
für die Kategorien aufgeführt. In der unteren 
Menüebene werden die Plug-Ins nach Hersteller 
geordnet. Dabei werden die einzelnen Plug-Ins in 
den Untermenüs für die Hersteller aufgeführt.

So wählen Sie aus, wie Plug-Ins aufgeführt werden:

1 Öffnen oder erstellen Sie eine Session. 

2 Wählen Sie Setup > Preferences und klicken 
Sie auf Display.

3 Klicken Sie auf das Popup-Menü Organize 

Plug-In Menus By und wählen Sie eine der 
Ansichtsoptionen aus.

4 Klicken Sie auf OK.

Die Einstellung von Organize Plug-In Menus By 
wird in den Pro Tools-Voreinstellungen (also nicht 
in der Pro Tools-Session-Datei) gespeichert.

Default EQ- und Dynamics-
Plug-Ins
Sie können ein Default EQ- und Dynamics-Plug-
In festlegen, wodurch diese im Popup-Menü des 
Insert-Selektors auf dem Bildschirm ganz oben 
und in der Liste der Menüoptionen zuerst 
angezeigt werden, wenn Sie Inserts auf ICON-
Arbeitsoberflächen zuweisen.

So legen Sie ein Standard-Plug-In fest:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing. 

2 Wählen Sie unter „Setup“ ein Standard-Plug-In 
aus dem Default EQ- oder Default Dynamics-
Popup-Menü.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

Wenn von einen Hersteller keine Plug-Ins 
im System installiert wurden, wird der 
entsprechende Unterordner nicht 
angezeigt.

Anzeige des Standard-Plug-Ins im Insert-Selektor-
Menü
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Plug-In-Favoriten
Um Plug-Ins schneller zu finden, können Sie sie als 
Favoriten kennzeichnen. Die Plug-In-Favoriten 
werden oben im Plug-In-Menü angezeigt. 

Wird ein Plug-In als Favorit ausgewiesen, 
erscheint es nach wie vor in seiner Kategorie, 
wobei sein Name in Fettschrift angezeigt wird.

So weisen Sie ein Plug-In als Favorit aus:

 Halten Sie die Befehlstaste (Mac) bzw. die Strg-
Taste (Windows) gedrückt und klicken Sie auf 
den Insert-Selektor.

So ändern Sie den Status eines als Favorit 
ausgewiesenen Plug-Ins:

 Halten Sie die Befehlstaste (Mac) bzw. die Strg-
Taste (Windows) gedrückt und klicken Sie auf 
den Insert-Selektor. Wählen Sie einen Plug-In-
Favoriten aus, den Sie nicht mehr als Favoriten 
kennzeichnen möchten. 

Dabei können Sie dieses Plug-In entweder in der 
Favoritenliste im oberen Teil des Plug-In-Menüs 
oder in seiner Plug-In-Kategorie auswählen.

Verschieben und Duplizieren 
von Plug-In- und Hardware-
Inserts
Sie können einen Insert verschieben oder 
duplizieren, indem Sie ihn an eine andere Position 
auf derselben Spur oder in eine andere Spur 
ziehen. Verschobene oder duplizierte Inserts 
behalten ihre ursprünglichen Einstellungen und 
Automationsdaten bei.

So verschieben Sie einen Insert:

 Ziehen Sie den Insert an die neue Position.

So duplizieren Sie einen Insert:

 Ziehen Sie den Insert bei gedrückter Alt- 
(Windows) bzw. Wahltaste (Mac) an die 
gewünschte Position. Duplizierte Plug-In-
Inserts weisen die ursprünglichen Einstellungen 
und die ursprüngliche Automation auf.

Menüanzeige von Plug-In-Favoriten

 

 

Favoriten-
Plug-Ins

Plug-In-
Kategorien

Plug-Ins können nicht während der 
Aufnahme verschoben oder dupliziert 
werden.

Verschieben eines Plug-Ins

Wenn Sie einen Insert genau auf einen 
vorhandenen ziehen, werden dieser und die 
entsprechenden Automationsdaten ersetzt.

Sie können Sends auch duplizieren. Siehe 
„Verschieben oder Kopieren von Sends“ auf 
Seite 1006
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Plug-In-Fenster
Ein Plug-In-Fenster wird geöffnet, wann immer 
Sie in einer Spur auf die Insert-Schaltfläche eines 
Plug-Ins klicken. In diesem unverankerten Fenster 
können Sie die Steuerelemente jedes Echtzeit-
Plug-In-Inserts bearbeiten, das auf einer Spur 
verwendet wird.

Spur-Steuerelemente im Plug-In-
Fenster

Track-Selektor. – greift auf Spuren in der Session 
zu, ausgenommen MIDI-, VCA- und Videospuren.

Insert Position-Selektor. – greift auf jedes Insert 
der aktuellen Spur zu.

Plug-In-Selektor. – ermöglicht die Auswahl eines 
beliebigen im Plug-In-Ordner installierten 
Echtzeit-Plug-Ins. Dieser Ordner wird bei der 
Installation von Pro Tools erstellt.

Key Input-Selektor. – ermöglicht die Auswahl 
eines bestimmten Eingangs oder Busses zur 
Übertragung des Audiomaterials, das Sie zur 
Ansteuerung des Plug-Ins nutzen möchten. Dieser 
Selektor erscheint lediglich in Plug-Ins, 
die Sidechain-Verarbeitung aufweisen. Key-
Eingänge sind monophon.

MIDI-Node-Anzeige. – zeigt Informationen zu 
MIDI-Nodes für MIDI-fähige Plug-Ins an. MIDI-
Nodes sind virtuelle Verknüpfungen zwischen 
Pro Tools und Software-Instrumenten und anderen 
MIDI-fähigen Plug-Ins. Sie eignen sich besonders 
zum gleichzeitigen Routen von mehreren MIDI-
Spuren auf die verschiedenen Kanäle eines 
einzigen virtuellen MIDI-Geräts. Die MIDI-Node-

Insert-Schaltfläche und Insert-Selektor in der Spur

Plug-In-Fenster (Mono-1-Band EQ III)

Insert-Schaltfläche

Insert-Selektor

Ziel-
Schaltfläche

Effekt-
Bypass

Automation Safe

Auto-
Schaltfläche

Convert 
Plug-In

Plug-In-Zuweisung
Steuerelemente

Track
Steuerelemente

Voreinstellung 
Steuerelemente

Spur-Steuerelemente im Plug-In-Fenster

Key Input-Selektor (Dyn III Compressor/Limiter)

Track-Selektor

Insert Position-Selektor

Plug-In-Selektor
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Nummern werden auch im MIDI Output-Selektor 
der Spur angezeigt. Die MIDI-Node-Anzeige ist 
nur in Plug-Ins vorhanden, die MIDI empfangen 
können.

Voreingestellte Steuerelemente im 
Plug-In-Fenster

Plug-In Settings-Menü. – ermöglicht das 
Kopieren, Einfügen, Speichern und Importieren 
von Plug-In-Einstellungen.

Plug-In Librarian-Menü. – ruft die Plug-In-
Voreinstellungen (Plug-In-Einstellungsdateien, 
die im Settings-Order des Plug-In-
Stammverzeichnisses oder der aktuellen Session 
gespeichert wurden) wieder auf. Siehe „Plug-In-
Voreinstellungen“ auf Seite 1053.

Schaltflächen für die nächste (+) und vorherige 
(–) Einstellung. – ermöglichen die Auswahl der 
nächsten bzw. vorherigen Voreinstellung im 
Librarian-Menü.

Plug-In Settings Select-Schaltfläche. – ruft das 
Plug-In Settings-Dialogfeld auf, in dem die 
Voreinstellungen für das ausgewählte Plug-In 
aufgeführt sind. In dieser Liste können Sie 
Voreinstellungen für Plug-Ins abhören und 
auswählen.

Compare. – schaltet zwischen der gespeicherten 
ursprünglichen Plug-In-Einstellung und den von 
Ihnen vorgenommenen Änderungen um, um einen 
Vergleich zu ermöglichen.

Automation-Steuerelemente im 
Plug-In-Fenster

Auto-Schaltfläche. – ermöglicht das Aktivieren 
einzelner Plug-In-Steuerelemente für die 
Aufzeichnung von Automationsdaten. Siehe 
„Automatisieren von Plug-Ins“ auf Seite 1089.

Automation Safe. – verhindert, dass vorhandene 
Plug-In-Automationsdaten überschrieben werden.

MIDI-Node-Anzeige (Transfuser)

Voreingestellte Steuerelemente im Plug-In-Fenster

Plug-In Settings-Menü

Plug-In Librarian-Menü

Compare-Schaltfläche

Einstellungsauswahl

Nächste Einstellung

Vorherige Einstellung

Wenn Sie die aktuellen Einstellungen vor 
Verwenden der Schaltflächen für die 
nächste und vorherige Einstellung nicht 
speichern, gehen diese verloren. Speichern 
Sie Ihre Plug-In-Einstellungen mithilfe des 
Plug-In Settings-Menüs daher immer als 
Voreinstellungen.

Automation-Steuerelemente im Plug-In-Fenster

Auto-Schaltfläche

Automation Safe-Schaltfläche
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Plug-In-Map-Steuerelemente im 
Plug-In-Fenster
(Nur Bedienoberflächen)

Wenn eine unterstützte Bedienoberfläche in 
Pro Tools zugewiesen wurde, werden die 
Steuerelemente der Plug-In-Zuweisung im Plug-
In-Fenster angezeigt. 

Map Options-Menü. – mithilfe dieses Menüs 
können Sie Standard-Plug-In-Zuweisungen 
erstellen, umbenennen, speichern, importieren, 
exportieren und festlegen. 

Map Presets-Menü. – in diesem Menü können Sie 
aus den verfügbaren Optionen eine Plug-In-
Zuweisung für das Plug-In wählen. 

Learn-Schaltfläche. – über diese Schaltfläche 
wechselt das Plug-In in den Learn-Modus. 
In diesem Modus können Sie Plug-In-Parameter 
einer Bedienoberfläche zuweisen. 

Parameter-Menü. – im Learn-Modus können Sie 
hier einen Parameter des Plug-Ins auswählen, 
der zugeordnet werden soll. Wenn Sie im Plug-In-
Fenster auf einen Parameter klicken, solange der 
Learn-Modus aktiviert ist, wird der Name des 
Parameters in diesem Menü angezeigt. 

Weitere Plug-In-Steuerelemente 
im Plug-In-Fenster

EffectBypass (Schaltfläche). – deaktiviert das 
gegenwärtig angezeigte Plug-In. Dadurch können 
Sie vergleichen, wie die Spur mit und ohne Effekt 
klingt.

Convert Plug-In-Selektor. – ermöglicht das 
Konvertieren des Inserts von einem DSP-Plug-In 
in ein natives Plug-In desselben Typs (oder 
umgekehrt). Diese Funktion kann nur mit Plug-Ins 
verwendet werden, die sowohl im DSP- als auch 
Native-Format verfügbar sind.

Target-Schaltfläche. – wenn mehrere Plug-In-
Fenster geöffnet sind, wählen Sie durch Klicken 
auf diese Schaltfläche das betreffende Plug-In als 
Ziel für Tastaturbefehle.

Plug-In-Map-Steuerelemente im Plug-In-Fenster

Map Options-Menü

Map Presets-Menü

Learn-Schaltfläche

Parameter-Menü

Plug-In-Map-Steuerelemente im Plug-In-Fenster

Plug-In-Bypass-Schaltfläche

Ziel-Schaltfläche

Convert Plug-In-Selektor
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Multimono-Steuerelemente im 
Plug-In-Fenster

Master-Link-Schaltfläche. – diese koppelt die 
Parametersteuerelemente aller Kanäle eines 
Multimono-Plug-Ins, sodass sie gemeinsam 
eingestellt werden können.

Link Enable-Schaltflächen. – diese Schaltflächen 
ermöglichen die selektive Koppelung (auch 
Aufheben der Koppelung) der 
Parametersteuerelemente einzelner Kanäle eines 
Multimono-Plug-Ins. Jedes Quadrat steht für einen 
Lautsprecherkanal. Die Master Link-Schaltfläche 
muss deaktiviert sein, damit Sie die Link Enable-
Schaltflächen verwenden können. Siehe „Koppeln 
der Steuerelemente von Multimono-Plug-Ins und 
Aufheben der Koppelung“ auf Seite 1067.

Channel-Selektor. – greift auf einen bestimmten 
Kanal innerhalb einer Mehrkanalspur zu, um die 
Bearbeitung über Plug-In-Steuerelemente zu 
ermöglichen. Dieses Menü erscheint lediglich auf 
Multimono-Plug-Ins, die auf Spuren mit mehr als 
einem Kanal eingeschleift wurden. Wenn Sie bei 
gedrückter Umschalttaste auf diesen Selektor 
klicken, wird für jeden Kanal der Mehrkanalspur, 
auf der das Plug-In eingeschleift wurde, 
ein eigenes Plug-In-Fenster geöffnet.

Aufrufen von Plug-In-
Fenstern
So rufen Sie ein Plug-In-Fenster auf:

 Klicken Sie im Inserts-Bedienfeld des Mix- 
oder Edit-Fensters auf die Plug-In-Schaltfläche.

Standardmäßig erscheint jedes neu geöffnete Plug-
In an derselben Position wie ein bereits offenes 
Plug-In, d. h., es ersetzt dieses. 

Öffnen mehrerer Plug-In-Fenster
Pro Tools zeigt normalerweise ein einziges Plug-
In-Fenster an, von dem aus Sie die Steuerelemente 
eines beliebigen Plug-Ins einer Session bearbeiten 
können. Sie können außerdem zusätzliche Plug-In-
Fenster für spezielle Plug-Ins öffnen. Wenn Sie 
mit mehreren Plug-In-Fenstern arbeiten, müssen 
Sie im Plug-In, dessen Steuerelemente Sie mithilfe 
von Tastaturbefehlen anpassen möchten, auf die 
Target-Schaltfläche klicken.

So rufen Sie weitere Plug-In-Fenster auf:

 Klicken Sie im Mix-Fenster bei gedrückter 
Umschalttaste auf die Insert-Schaltfläche eines 
Plug-Ins. Das neue Plug-In-Fenster wird 
geöffnet, ist jedoch nicht als Ziel ausgewählt.

So öffnen Sie die Plug-In-Fenster für jeden Kanal 
eines Multimono-Plug-Ins:

 Klicken Sie bei gedrückter Alt- (Windows) 
bzw. Wahltaste (Mac) im Plug-In-Fenster eines 
Plug-In-Inserts auf den Channel-Selektor. 

So schließen Sie alle geöffneten Plug-In-Fenster:

 Klicken Sie bei gedrückter Alt- (Windows) 
bzw. Wahltaste (Mac) auf das Schließfeld eines 
beliebigen geöffneten Plug-In-Fensters. 

Plug-In-Fenster (Multimono-1-Band EQ)

Channel-Selektor

Link Enable-Schaltflächen

Master-Link-Schaltfläche
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Verwenden von Plug-In-
Fenster-Steuerelementen
Alle Plug-Ins bieten, zusätzlich zu EQ-, Dynamik- 
und anderen prozessorspezifischen 
Steuerelementen, Standard-Pro Tools-
Steuerelemente für Funktionen wie Spuren- und 
Insert-Auswahl, Bypass usw. 

So wählen Sie auf derselben Spur ein anderes 
Plug-In:

 Klicken Sie auf den Insert-Selektor und wählen 
Sie im Popup-Menü ein Plug-In.

So wählen Sie eine andere Spur:

 Klicken Sie auf den Track-Selektor und wählen 
Sie im Popup-Menü eine andere Spur aus.

Zielfenster und Tastaturbefehle für 
Einstellungen

Wenn mehrere Plug-In-Fenster geöffnet sind, 
kennzeichnet eine hervorgehobene Zielscheibe das 
Zielfenster. Standardmäßig ist in Pro Tools ein 
einziges Plug-In-Fenster als Zielfenster geöffnet. 
Wenn Sie ein neues Plug-In öffnen, wird dieses als 
neues Zielfenster an derselben Position geöffnet. 
Außerdem dient das Plug-In-Zielfenster als Ziel für 
Tastenkombinationen für Plug-In-Einstellungen. 

Bearbeiten von Plug-In-
Steuerelementen
Sie können Plug-In-Steuerelemente bearbeiten, 
indem Sie den Regler ziehen oder einen Wert in das 
Textfeld des betreffenden Steuerelements eingeben. 
Anleitungen zum Bearbeiten bestimmter Plug-Ins 
finden Sie in der Dokumentation für das Plug-In.

So stellen Sie ein Plug-In-Steuerelement ein:

1 Beginnen Sie mit der Audiowiedergabe, sodass 
Sie die mit dem Steuerelement vorgenommenen 
Veränderungen in Echtzeit hören können.

2 Passen Sie die Steuerelemente des Plug-Ins an, 
um den gewünschten Effekt zu erreichen.

3 Wenn das Plug-In-Fenster geschlossen wird, 
werden die aktuellsten Änderungen gespeichert.

Einstellen von Plug-In-
Parametern mit der Maus
Drehregler können mit der Maus durch 
horizontales oder vertikales Ziehen bedient 
werden. Die Parameterwerte steigen an, wenn Sie 
nach oben bzw. rechts ziehen, und sinken, wenn 
Sie nach unten bzw. links ziehen.

Tastenkombinationen

 Um detailliertere Anpassungen vorzunehmen, 
ziehen Sie das Steuerelement bei gedrückter Strg- 
(Windows) bzw. Befehlstaste (Mac).

 Um ein Steuerelement auf seinen Standardwert 
zurückzusetzen, klicken Sie bei gedrückter Alt- 
(Windows) bzw. Wahltaste (Mac) darauf. 

Informationen über die spezifischen 
Steuerelemente der einzelnen Plug-Ins (mit 
Pro Tools installiert) finden Sie im Audio-
Plug-Ins-Handbuch. Weitere kostenlose 
Plug-Ins (und kostenpflichtige Plug-In-
Optionen), die mit Pro Tools installiert 
werden können, sind ebenfalls im Audio-
Plug-Ins-Handbuch dokumentiert.
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Einstellen von Plug-In-
Parametern über die Tastatur
Sie können mithilfe Ihrer Computertastatur Plug-
In-Steuerelemente bearbeiten.

Wenn mehrere Plug-In-Fenster geöffnet sind, 
wirken sich über die Tastatur eingegebene Befehle 
nur auf das Plug-In im Zielfenster aus.

So ändern Sie die Steuerelementwerte mit der 
Computertastatur:

1 Um das Textfeld des gewünschten 
Steuerelements zu aktivieren, klicken Sie 
darauf oder navigieren Sie dorthin. 

2 Führen Sie einen der folgenden Schritte aus, 
um den Wert zu ändern:

• Um einen Wert zu erhöhen, drücken Sie auf 
Ihrer Tastatur die Nach-oben-Pfeiltaste. 

• Um einen Wert zu verringern, drücken Sie auf 
Ihrer Tastatur die Nach-unten-Pfeiltaste.

• Geben Sie den Wert ein.

3 Führen Sie einen der folgenden Schritte aus, 
um den Wert zu bestätigen:

• Drücken Sie die Enter-Taste des Ziffernblocks, 
um die Eingabe zu bestätigen, ohne den 
Tastaturbearbeitungsmodus zu verlassen.

• Drücken Sie die Eingabetaste (Windows) bzw. 
die Return-Taste (Mac) auf der 
alphanumerischen Tastatur, um den Wert zu 
bestätigen und den Tastaturbearbeitungsmodus 
zu verlassen.

So setzen Sie alle Übersteuerungsanzeigen, 
einschließlich Plug-In-Übersteuerungen, zurück:

 Drücken Sie Alt + C (Windows) bzw. Wahl + 
C (Mac).

Plug-In-Automation und 
Automationssicherung
Alle Echtzeit-Plug-Ins können vollständig 
automatisiert werden und unterstützen sämtliche 
Pro Tools-Automationsmodi (also die Modi Write, 
Touch, Latch und Trim). 

Die Auto-Schaltfläche öffnet das Plug-In 
Automation-Dialogfeld, wo Sie einzelne Plug-In-
Steuerelemente für die Aufzeichnung von 
Automationsdaten aktivieren können (siehe 
„Automatisieren von Plug-Ins“ auf Seite 1089).

Die Safe-Schaltfläche schaltet den Automation 
Safe-Modus ein. So wird verhindert, dass 
vorhandene Plug-In-Automationsdaten 
überschrieben werden (siehe „Sichern der Plug-In-
Automation“ auf Seite 1091).

Das Plug-In-Zielfenster dient als Ziel für 
Tastenkombinationen für Plug-In-
Einstellungen. Um ein Plug-In als Ziel für 
Tastaturbefehle (einschließlich 
Tastenkombinationen) auszuwählen, klicken 
Sie im Plug-In-Fenster auf die Target-
Schaltfläche des Plug-Ins.

Um die Felder für die verschiedenen 
Steuerelemente vorwärts durchzublättern, 
drücken Sie die Tab-Taste. Um rückwärts 
zu blättern, drücken Sie Umschalt + Tab.

Wenn Sie in Felder, die Werte in Kilohertz 
unterstützen, ein „k“ nach einem Zahlenwert 
eingeben, so wird der Wert mit 1.000 
multipliziert. Für den Wert 8.000 können Sie 
beispielsweise „8k“ eingeben.
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Sidechain-Eingang
Der Sidechain-Eingang ist das abgetrennte Signal, 
mit dem der Detektor eines Plug-Ins die dynamische 
Verarbeitung auslöst. Es wird in der Regel intern 
vom Eingangssignal abgenommen. Bei einigen 
Plug-Ins können Sie jedoch zwischen interner und 
externer Sidechain-Verarbeitung wählen.

Bei der externen Sidechain-Bearbeitung wird der 
Detektor eines Plug-Ins durch ein externes Signal 
(beispielsweise von einer separaten Referenzspur 
oder Audioquelle) ausgelöst. Dieses Signal 
bezeichnet man als Key-Eingang.

In der Regel wird die externe Sidechain-
Verarbeitung dazu verwendet, die Dynamik eines 
Audiosignals über die Dynamik eines anderen 
Signals (des Key-Eingangs) zu steuern. So können 
Sie beispielsweise ein Gate-Plug-In auf einer 
Bass-Spur von einer Kick-Drum-Spur aus 
triggern, um ein klareres Klangbild zu erzielen, 
oder ein Gate für ein Keyboard-Pad von einer 
Rhythmusgitarrenspur aus steuern.

Sidechain-Filter

Einige Plug-Ins verfügen über Hoch- und 
Tiefpassfilter für das Key-Signal. Mit diesen 
Steuerelementen können Sie einen bestimmten 
Frequenzbereich im Sidechain-Signal festlegen, 
mit dem der Plug-In-Effekt getriggert werden soll. 
Es ist eine gängige Methode, mit diesen 
Steuerelementen eine Drum-Spur so zu filtern, dass 
nur bestimmte hochfrequente Klänge (etwa Hi-
Hat) oder Klänge mit tiefen Frequenzen (etwa Tom 
oder Bassdrum) den Effekt ansteuern bzw. triggern.

Verwenden eines Key-Eingangs 
zur externen Sidechain-
Verarbeitung
So verwenden Sie den Key-Eingang zur externen 
Sidechain-Verarbeitung:

1 Klicken Sie auf den Key Input-Selektor des 
Plug-Ins und wählen Sie den Eingang oder Bus 
zur Übertragung des Audiomaterials, das Sie 
zur Ansteuerung des Plug-Ins nutzen möchten.

2 Klicken Sie auf die External Key-Schaltfläche, um 
die externe Sidechain-Verarbeitung zu aktivieren.

3 Drücken Sie die Leertaste, um die Wiedergabe 
zu starten. Das Plug-In verwendet nun den von 
Ihnen ausgewählten Eingang oder Bus als Key-
Eingang zum Triggern des Effekts.

4 Führen Sie während der Wiedergabe einen der 
folgenden Vorgänge aus, um das Auslösen der 
Key-Eingang-Verarbeitung anzupassen:

• Um die zum Steuern des Key-Eingangs 
bestimmte Audioquelle abzuhören, aktivieren Sie 
„Side-Chain Listen“ oder „Key Listen“ (je nach 
Plug-In). Deaktivieren Sie die Side-Chain Listen- 
bzw. Key Listen-Option anschließend, um das 
Plug-In wieder normal abzuhören.

• Benutzen Sie die Filtersteuerelemente (sofern 
vorhanden) zur Wahl der Frequenzbereiche, 
um den Key-Eingang so zu filtern, dass nur 
Signale bestimmter Frequenzbereiche das Plug-
In ansteuern.

5 Passen Sie das Threshold-Steuerelement 
(sofern vorhanden) und andere Steuerelemente 
nach Bedarf an.

Auswählen eines Key-Eingangs
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Plug-In-Voreinstellungen
Pro Tools ermöglicht Ihnen das mühelose Verwalten 
Ihrer Plug-In-Einstellungen oder -Voreinstellungen. 
Mithilfe des Plug-In Settings-Menüs können Sie 
diese Einstellungen kopieren, einfügen, speichern 
und aus anderen Plug-Ins oder Sessions importieren.

Nachdem Sie Einstellungsdateien erzeugt und auf 
der Festplatte gespeichert haben (und Pro Tools 
durch Zuweisung eines Stammordners mitteilen, 
wo diese zu finden sind), werden sie im Plug-In 
Librarian-Menü und im Plug-In Settings-
Dialogfeld angezeigt. Darüber hinaus werden sie 
in Workspace-Browsern als Plug-In-
Einstellungsdateien (.txf) angezeigt.

Plug-In Settings-Menü
Das Plug-In Settings-Menü ermöglicht das 
Kopieren, Einfügen, Speichern und Verwalten von 
Plug-In-Einstellungen als Presets (Plug-In-
Einstellungsdateien).

Im Plug-In Settings-Menü stehen folgende Befehle 
zur Verfügung:

Save Settings. – speichert die derzeit aktiven 
Einstellungen. Ist eine ältere Version der 
Voreinstellung vorhanden, wird sie mit diesem 
Befehl überschrieben.

Save Settings As. – speichert die aktuellen 
Einstellungen als neue Voreinstellungen unter 
einem anderen Namen.

Copy Settings. – kopiert die derzeit aktiven Plug-
In-Einstellungen. Sie können diese Einstellungen 
auf ein Plug-In des gleichen Typs in einer anderen 
Spur anwenden, indem Sie die Spur im Plug-In-
Fenster auswählen und die Einstellungen mit dem 
Paste Settings-Befehl einfügen.

Paste Settings. – fügt Plug-In-Einstellungen ein, 
die vorher mit dem Copy Settings-Befehl kopiert 
wurden.

Import Settings. – importiert Plug-In-
Einstellungsdateien (.tfx), die sich nicht im 
Stammordner für die Einstellungen oder im 
Session-Ordner befinden. 

Delete Current Settings File. – löscht die derzeit 
ausgewählte Plug-In-Einstellungsdatei (.tfx) von 
der Festplatte.

Lock Settings File. – verhindert, dass die derzeit 
aktive Voreinstellung durch den Save-Befehl 
überschrieben wird. Wenn Sie Änderungen der 
Plug-In-Einstellungen speichern möchten, werden 
Sie aufgefordert, sie entweder unter einem anderen 
Namen oder in einem anderen Verzeichnis zu 
speichern.

Set As User Default. – legt die derzeit aktive 
Voreinstellung als benutzerdefinierte 
Standardeinstellung (User Default) für das 
ausgewählte Plug-In fest.

Im Plug-In Settings-Dialogfeld können Sie 
Plug-In-Einstellungen abhören und 
auswählen (siehe „Plug-In Settings-
Dialogfeld“ auf Seite 1056).

Plug-In Settings-Menü
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Settings Preferences
Das Settings Preferences-Untermenü enthält 
Befehle zum Konfigurieren von Einstellungen 
zum Speichern und Importieren von 
Voreinstellungen. Die folgenden Untermenüs 
stehen zur Verfügung:

Set Plug-In Default To. – in diesem Untermenü 
können Sie entweder Factory Default (die 
Standardeinstellung für dieses Plug-In) oder User 

Default (die von Ihnen vorgenommene 
Einstellung) als Standardvoreinstellung festlegen.

Save Plug-In Settings To. – erlaubt die Auswahl 
des Ordners, in dem Voreinstellungen (Plug-In-
Einstellungsdateien) gespeichert werden. Wenn 
Sie Session Folder auswählen, werden die 
Einstellungen in einem Ordner namens „Plug-In 
Settings“ gespeichert, der sich im aktuellen 
Session-Ordner befindet. Wenn Sie den Root 

Settings Folder auswählen, werden die 
Einstellungen in dem Ordner gespeichert, den Sie 
mit dem Set Root Settings Folder-Befehl definiert 
haben. Sie können den Speicherort des Ordners 
„Root Settings“ unter „Operation Preferences“ 
ändern (siehe „User Library-Abschnitt“ auf 
Seite 110).

Auswahl eines Speicherorts für 
Einstellungen
Bevor Sie Plug-In-Einstellungen speichern, 
müssen Sie einen Zielordner festlegen.

So wählen Sie einen Zielordner: 

 Wählen Sie im Plug-In Settings-Menü Settings 

Preferences > Save Plug-In Settings To und 
wählen Sie entweder Session Folder oder Root 

Settings Folder.

Wenn Sie Root Settings Folder gewählt haben, 
speichert Pro Tools die Einstellungen im 
vorgegebenen Plug-In Settings-Stammordner, 
sofern Sie keinen anderen Speicherort für den 
Stammordner für Einstellungen angegeben haben.

So bestimmen Sie einen anderen Stammordner 
für Einstellungen:

1 Wählen Sie im Plug-In Settings-Menü Settings 

Preferences > Set Root Settings Folder.

2 Wählen Sie den Ordner aus, den Sie als 
Stammordner verwenden möchten, und klicken 
Sie auf Select. 

Erstellen von Unterordnern für 
Einstellungen
Durch Aufteilung der Einstellungsdateien in 
weitere Unterordner können Sie bestimmte 
Einstellungstypen leichter finden.

So erstellen Sie einen Unterordner für 
Einstellungen:

1 Wählen Sie im Plug-In Settings-Menü Save 

Settings.

2 Klicken Sie auf die New Folder-Schaltfläche und 
geben Sie einen Namen für den Unterordner an.

3 Geben Sie der Voreinstellung einen Namen und 
klicken Sie auf Save. Die neue Plug-In-
Einstellungsdatei wird nun im Unterordner 
gespeichert. 

Wenn Sie die Plug-In-Einstellungen an einem 
anderen Ort als im Ordner „Plug-In 
Settings“ speichern möchten, müssen Sie am 
neuen Speicherort zuerst einen Ordner 
namens „Plug-In Settings“ erstellen, in dem 
Sie die Einstellungen dann speichern können.
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Verwalten von Voreinstellungen
Mit dem Plug-In Settings-Menü können Sie 
Voreinstellungen verwalten.

So speichern Sie eine Voreinstellung: 

1 Wählen Sie im Plug-In Settings-Menü Save 

Settings.

2 Geben Sie einen Namen ein und klicken Sie auf 
OK. Die Einstellung wird nun im Plug-In 
Librarian-Menü angezeigt.

So laden Sie eine Plug-In-Voreinstellung:

 Wählen Sie im Plug-In Librarian-Menü den 
Namen der Voreinstellung aus.

So importieren Sie eine Voreinstellung: 

1 Wählen Sie im Plug-In Settings-Menü Import 

Settings.

2 Suchen Sie die gewünschte Einstellungsdatei 
und klicken Sie auf Open. Pro Tools lädt die 
Einstellung und kopiert sie in das 
Stammverzeichnis für den Zielordner.

So kopieren Sie Plug-In-Einstellungen: 

 Wählen Sie im Plug-In Settings-Menü Copy 

Settings.

So fügen Sie Plug-In-Einstellungen ein: 

1 Öffnen Sie das Plug-In, in das die Einstellungen 
eingefügt werden sollen.

2 Wählen Sie im Plug-In Settings-Menü Paste 

Settings.

So erstellen Sie eine benutzerdefinierte 
Standardvoreinstellung: 

1 Erstellen und speichern Sie eine Plug-In-
Einstellungsdatei.

2 Wählen Sie im Plug-In Settings-Menü Set As 

User Default. 

So bestimmen Sie ein Plug-In als Vorgabe für Ihre 
eigene Voreinstellung: 

 Wählen Sie aus dem Plug-In Settings-Menü 
Settings Preferences > Set Plug-In Default To > 

User Setting.

Bei nicht gekoppelten Multimono-Plug-Ins 
gelten besondere Regeln für die 
Einstellungen. Siehe „Koppeln der 
Steuerelemente von Multimono-Plug-Ins und 
Aufheben der Koppelung“ auf Seite 1067.

Drücken Sie Strg + Umschalt + S 
(Windows) bzw. Befehl + Umschalt + S 
(Mac), um die Plug-In-Einstellungen zu 
speichern.

Drücken Sie Strg + Umschalt + C (Windows) 
bzw. Befehl + Umschalt + C (Mac), um die 
Plug-In-Einstellungen zu kopieren.

Drücken Sie Strg + Umschalt + V 
(Windows) bzw. Befehl + Umschalt + V 
(Mac), um die Plug-In-Einstellungen 
einzufügen.
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Ändern von Voreinstellungen 
mit Schaltflächen für die 
nächste (+) und vorherige (–) 
Einstellung
Mit diesen Schaltflächen können Sie die nächste 
bzw. die vorherige Voreinstellung im Plug-In 
Librarian-Menü auswählen.

So ändern Sie die Plug-In-Voreinstellungen über 
die Plus- bzw. Minusschaltfläche:

 Klicken Sie auf die Plus- (+) oder 
Minusschaltfläche (–), um die nächste oder die 
vorherige Voreinstellung auszuwählen. 
Die nächste (oder vorherige) Voreinstellung 
wird aktiviert und das Plug-In Librarian-Menü 
ändert sich, indem es den Namen der neuen 
Voreinstellung anzeigt.

Bearbeiten der Einstellungen 
von nicht gekoppelten 
Multimono-Plug-Ins
Wenn ein Multimono-Plug-In nicht gekoppelt ist, 
haben das Importieren, Kopieren, Einfügen oder 
das Schalten auf Bypass nur Auswirkungen auf 
den aktuell ausgewählten Kanal.

Plug-In Settings-Dialogfeld
Im Plug-In Settings-Dialogfeld werden die 
Voreinstellungen für den aktuellen Plug-In-Typ 
aufgelistet. In dieser Liste können Sie 
Voreinstellungen abhören und auswählen.

Im Folder-Popup-Menü im oberen Teil des Plug-In 
Settings-Dialogfelds können Sie zwischen 
verschiedenen Unterordnern mit Plug-In-
Einstellungen oder zwischen dem Stammordner und 
dem Session-Ordner für Einstellungen umschalten.

Das Plug-In Settings-Dialogfeld verfügt über die 
folgenden Optionen:

Ordner. – in diesem Popup-Menü können Sie 
zwischen den Einstellungen im Stamm- und den 
Voreinstellungen in den Session-Ordnern (und 
eventuellen Unterordnern) wechseln.

Patch. – in diesem Feld wird der Name der aktiven 
(hervorgehobenen) Voreinstellung angezeigt.

Increment Patch Every X Sec. – mit dieser Option 
können Sie Plug-In-Voreinstellungen 
nacheinander abhören, indem sie automatisch eine 
festgelegte Anzahl von Sekunden lang 
nacheinander verwendet werden.

Wenn Sie die aktuellen Plug-In-Einstellungen 
vor Verwenden der Schaltflächen für die 
nächste und vorherige Einstellung nicht 
speichern, gehen sie verloren. Speichern Sie 
die Plug-In-Einstellungsdatei immer in den 
ausgewählten Stammordner für die 
Einstellungen.

Plug-In Settings-Dialogfeld
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So ändern Sie die Plug-In-Voreinstellungen im 
Plug-In Settings-Dialogfeld:

1 Klicken Sie auf die Settings Select-
Schaltfläche.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie eine Voreinstellung aus der Liste im 
Dialogfeld aus.

• Mit den Pfeiltasten können Sie die verfügbaren 
Voreinstellungen durchgehen. 

3 Klicken Sie auf Done.

Abhören von Plug-In-
Voreinstellungen
Wenn das Plug-In Settings-Dialogfeld geöffnet ist, 
können Sie in Pro Tools die im 
Stammeinstellungsordner des Plug-Ins oder im 
Einstellungsordner der aktuellen Session 
gespeicherten Plug-In-Einstellungsdateien 
automatisch durchgehen und abhören.

So hören Sie Plug-In-Voreinstellungen ab:

1 Klicken Sie auf die Settings Select-
Schaltfläche.

2 Klicken Sie in der Liste des Dialogfelds auf eine 
Voreinstellung. Wenn Sie dann die 
Einstellungsdateien durchgehen, beginnen Sie 
mit diesem Eintrag.

3 Sie können einen Wert in Sekunden eingeben 
und damit die Zeit festlegen, die zwischen den 
einzelnen Voreinstellungswechseln liegen soll.

4 Wählen Sie die Increment Setting-Option.

Nach Ablauf des angegebenen Zeitraums wählt 
Pro Tools die nächste Voreinstellung aus. 

5 Nach dem Abhören der Voreinstellungen haben 
Sie folgende Möglichkeiten:

• Klicken Sie auf Done, um den Durchlauf 
anzuhalten und das Plug-In Settings-Dialogfeld 
zu schließen.

• Deaktivieren Sie die Option Increment Patch, 
um den Durchlauf anzuhalten und das Plug-In 
Settings-Dialogfeld geöffnet zu lassen. Wählen 
Sie dann die gewünschte Voreinstellung aus und 
klicken Sie auf Done.

Workspace- und Plug-In-
Einstellungsdateien
Workspace-Browser erkennen Plug-In-
Einstellungsdateien (.txf) als bekannten Typ und 
ermöglichen Drag & Drop in Plug-In-Fenstern und 
-Inserts in Pro Tools. Sie können auch Plug-In-
Einstellungen nach Typ suchen.

Zum Wechseln zwischen den verschiedenen 
Unterordnern mit Einstellungen halten Sie 
die Strg- (Windows) bzw. Befehlstaste (Mac) 
gedrückt und verwenden Sie die Nach-oben- 
oder Nach-unten-Pfeiltaste.
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Suchen von Plug-In-
Einstellungsdateien

So suchen Sie Plug-In-Einstellungsdateien:

1 Klicken Sie im Workspace-Browser auf das 
Suchsymbol.

2 Wählen Sie für die Suchkriterien „Kind > Is > 

Plug-In Settings File“.

3 Zur weiteren Eingrenzung Ihrer Suche legen Sie 
weitere Suchkriterien nach Bedarf fest.

Drag & Drop von Plug-In-
Einstellungsdateien
Sie können ein Plug-In mit einer bestimmten Plug-
In-Einstellungsdatei einfügen und auch die Plug-
In-Einstellungen eingefügter Plug-Ins ändern, 
indem Sie per Drag & Drop Plug-In-
Einstellungsdateien aus einem Workspace-
Browser ziehen und ablegen.

So fügen Sie ein Plug-In per Drag & Drop ein:

 Ziehen Sie eine Plug-In-Einstellungsdatei aus 
einem Workspace-Browser und legen Sie sie 
auf einem Insert im Mix-Fenster (oder Edit-
Fenster) ab.

So ändern Sie eine Plug-In-Voreinstellung per 
Drag & Drop:

 Ziehen Sie eine Plug-In-Einstellungsdatei aus 
einem Workspace-Browser in das Plug-In-
Fenster. Die Plug-In-Einstellungsdatei muss 
sich auf denselben Plug-In-Namen beziehen. 
Beispielsweise können Sie eine 1-Band EQ 3 
nicht mit einer Plug-In-Einstellung für 4-Band 
EQ 3 ersetzen.

Suchen von Plug-In-Einstellungsdateien

Sie können Kataloge bestimmter, häufig 
verwendeter Plug-In-Einstellungen erstellen, 
um Ihren Workflow zu optimieren. Weitere 
Informationen zu Katalogen finden Sie unter 
„Kataloge“ auf Seite 318.

Ziehen und Ablegen einer Plug-In-Einstellungsdatei 
auf ein Insert

Drag & Drop einer Plug-In-Einstellungsdatei auf ein 
Plug-In
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Auswählen von Plug-In-
Voreinstellungen über den Plug-
In-Selektor
In Pro Tools können Sie die Plug-In-Einstellungen 
über das Insert-Rechtsklick-Menü auswählen, 
indem Sie das User Presets-Untermenü verwenden.

So wählen Sie eine Plug-In-Einstellung für ein 
Plug-In-Insert im Mix- oder Edit-Fenster aus:

1 Klicken Sie in der Inserts-Ansicht im Mix- oder 
Edit-Fenster mit der rechten Maustaste auf das 
Plug-In-Insert-Symbol.

2 Wählen Sie im User Presets-Untermenü die 
gewünschte Plug-In-Einstellung.

Plug-In-Zuweisung
(Nur Bedienoberflächen)

Sie können die Anordnung der Plug-In-Parameter-
Steuerelemente auf den unterstützten 
Bedienoberflächen in Pro Tools anpassen. 
Die angepassten Plug-In-Zuweisungen können als 
Voreinstellungen gespeichert, exportiert und somit 
in verschiedenen Sessions und auf verschiedenen 
Systemen verwendet werden. Plug-In-Zuweisungen 
werden im entsprechenden Unterordner im 
Pro Tools-Ordner „Root Settings“ gespeichert. 
Sie können den Speicherort des Ordners „Root 
Settings“ unter „Operation Preferences“ ändern 
(siehe „User Library-Abschnitt“ auf Seite 110).

Plug-In-Learn-Modus

Plug-Ins können in den Learn-Modus geschaltet 
werden. In diesem Modus kann jeder 
automatisierbare Plug-In-Parameter einem 
Drehgeber, Auswahlschalter oder (im Flip-Modus) 
einem Fader für Kanalzüge auf der 
Bedienoberfläche zugeordnet werden. 

Plug-In-Map-Voreinstellungen

Eine Zuweisung für ein Plug-In (Plug-In-Map) 
kann gespeichert und für jedes beliebige Plug-In 
desselben Typs wieder abgerufen werden. 

Sie können mehrere Map-Voreinstellungen für ein 
einzelnes Plug-In speichern und während einer 
Session jederzeit zwischen Zuweisungen wechseln. 

Weiterhin können Sie zeitgleich mehrere Map-
Voreinstellungen auf verschiedenen Instanzen 
eines Plug-Ins verwenden. Dies ist hilfreich bei 
virtuellen Instrumenten-Plug-Ins mit mehreren 
Konfigurationen oder bei Workflows mit 
mehreren Benutzern auf großen Systemen.

Sie können eine benutzerdefinierte Plug-In-
Zuweisung als Standardzuordnung für ein Plug-In 
festlegen, sodass dieselbe Zuweisung für alle 
Standardinstanzen des Plug-Ins verwendet wird.

Insert-Rechtsklick-Menü im Mix-Fenster
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Plug-In-Map-Dateien

Plug-In-Zuweisungen können in eine PIM-Datei 
exportiert und in anderen Sessions sowie auf 
anderen Systemen mit einer Bedienoberfläche 
ähnlicher Art (beispielsweise einer Oberfläche mit 
8 oder 24 Fadern bzw. einer ICON-Oberfläche) 
verwendet werden. 

Zuweisung von Bedienoberflächen

Wenn Sie eine benutzerdefinierte Plug-In-
Zuweisung erstellen, werden die zugehörigen 
Parameter auf Seiten angeordnet, die den 
Bedienelementen auf der Bedienoberfläche 
entsprechen. Die Größe einer Seite hängt von der 
Art der Bedienoberfläche ab. Für jede 
benutzerdefinierte Plug-In-Zuweisung können bis 
zu 200 Seiten mit zugeordneten Parametern 
angelegt werden.

Plug-In-Zuweisungen werden entsprechend der 
folgenden Bedienoberflächen-Typen gespeichert:

• 003

• C|24

• Command|8

• D-Control

• D-Command

• EUCON-kompatible Controller

• M-Audio-Controller

Plug-In-Map-Steuerelemente
Wenn eine unterstützte Bedienoberfläche in 
Pro Tools zugewiesen wurde, werden die 
Steuerelemente der Plug-In-Zuweisung im Plug-
In-Fenster angezeigt. 

Map Options-Menü. – mithilfe dieses Menüs 
können Sie Standard-Plug-In-Zuweisungen 
erstellen, umbenennen, speichern, importieren, 
exportieren und festlegen. 

Map Presets-Menü. – in diesem Menü können Sie 
aus den verfügbaren Optionen eine Plug-In-
Zuweisung für das Plug-In wählen. 

Learn-Schaltfläche. – über diese Schaltfläche 
wechselt das Plug-In in den Learn-Modus. In 
diesem Modus können Sie Plug-In-Parameter 
einer Bedienoberfläche zuweisen. 

Parameter-Menü. – im Learn-Modus können Sie 
hier einen Parameter des Plug-Ins auswählen, der 
zugeordnet werden soll. Wenn Sie im Plug-In-
Fenster auf einen Parameter klicken, solange der 
Learn-Modus aktiviert ist, wird der Name des 
Parameters in diesem Menü angezeigt. 

Plug-In-Map-Steuerelemente können ein- oder 
ausgeblendet werden.

So blenden Sie Plug-In-Map-Steuerelemente ein 
(oder aus):

 Aktivieren (oder deaktivieren) Sie View > Plug-

In > Map Controls.

Wenn Sie eine Plug-In-Zuweisung 
importieren, die auf einem anderen 
Bedienoberflächen-Typ erstellt wurde, wird 
diese im Map Presets-Menü lediglich als 
inaktiv angezeigt.

Plug-In-Map-Steuerelemente im Plug-In-Fenster

Map Options-Menü

Map Presets-Menü

Learn-Schaltfläche

Parameter-Menü
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Erstellen von Plug-In-
Zuweisungen
In diesem Abschnitt wird das Erstellen von Plug-
In-Zuweisungen auf folgenden Bedienoberflächen 
erläutert:

• C|24

• 003

• Command|8

Aktivieren des Learn-Modus in einem 
Plug-In

Wenn Sie erstmalig den Learn-Modus aktivieren, 
wird eine neue Plug-In-Zuweisung erstellt 
(standardmäßig unter dem Namen „Custom 
Map“). Das Plug-In wird auf der Bedienoberfläche 
zentriert angezeigt, wobei die Steuerelement-Seite 
leer und somit bereit für Zuweisungen ist.

Der Learn-Modus kann immer nur für ein Plug-In 
zur selben Zeit aktiviert sein.

So aktivieren Sie den Learn-Modus für ein Plug-In:

 Klicken Sie im Plug-In-Fenster auf die Learn-
Schaltfläche.

 Wählen Sie im Map Options-Popup-Menü die 
New Map-Option.

So deaktivieren Sie den Learn-Modus für ein Plug-In:

 Klicken Sie im Plug-In-Fenster auf die aktive 
Learn-Schaltfläche. 

 Schließen Sie das Plug-In-Fenster.

 Klicken Sie in einem anderen Plug-In-Fenster 
auf die Learn-Schaltfläche. 

Erstellen und Bearbeiten von 
Plug-In-Zuweisungen

So erstellen Sie eine benutzerdefinierte 
Zuweisung von Plug-In-Parametern:

1 Öffnen Sie das Plug-In, dessen Zuweisungen 
Sie bearbeiten möchten. 

2 Aktivieren Sie den Learn-Modus für das Plug-
In. Das Plug-In wird auf der Bedienoberfläche 
zentriert angezeigt, wobei die Steuerelement-
Seite leer und somit bereit für Zuweisungen ist. 

3 Klicken Sie im Plug-In-Fenster auf den Plug-In-
Parameter, den Sie zuweisen möchten. Der 
Parameter wird anschließend im Parameter-
Menü angezeigt. 

4 Führen Sie auf der Bedienoberfläche einen der 
folgenden Schritte aus: 

• Drehen Sie den Drehgeber oder drücken Sie den 
Schalter zur Kanalauswahl, den Sie dem 
Parameter zuweisen möchten. 

• Wenn sich die Bedienoberfläche im Flip-Modus 
befindet, verschieben Sie den Fader oder 
drücken Sie den Schalter zur Kanalauswahl, den 
Sie dem Parameter zuweisen möchten. 

5 Wiederholen Sie die Schritte 3–4 für jeden 
weiteren Parameter, den Sie zuweisen möchten. 

6 Deaktivieren Sie den Learn-Modus für das 
Plug-In.

Weitere Informationen über die Plug-In-
Zuweisung für D-Control und D-Command 
finden Sie im D-Control-Handbuch und 
D-Command-Handbuch. 

Der Learn-Modus von Plug-Ins wird 
automatisch deaktiviert, wenn das Plug-In an 
eine andere Insert-Position bewegt, 
stummgeschaltet oder in DSP- oder Native-
Formate konvertiert wird. 
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So ändern Sie die Parameter-Zuweisung in einer 
Plug-In-Zuweisung:

1 Öffnen Sie das Plug-In, dessen 
benutzerdefinierte Zuweisungen Sie ändern 
möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die Sie ändern möchten. 

3 Aktivieren Sie den Learn-Modus für das Plug-
In. Das Plug-In wird zentriert auf der 
Bedienoberfläche angezeigt.

4 Gehen Sie für jede Parameter-Zuweisung, 
die Sie ändern möchten, wie folgt vor:

• Klicken Sie im Plug-In-Fenster auf den Plug-In-
Parameter, den Sie zuweisen möchten. 
Der Parameter wird anschließend im Parameter-
Menü angezeigt. 

• Wählen Sie auf der Bedienoberfläche den 
Drehgeber oder Schalter, dessen Zuweisung Sie 
ändern möchten, und drehen Sie den Regler bzw. 
drücken Sie den Schalter.

5 Deaktivieren Sie den Learn-Modus für das 
Plug-In.

So entfernen Sie die Parameter-Zuweisung aus 
einer Plug-In-Zuweisung:

1 Öffnen Sie das Plug-In, dessen benutzerdefinierte 
Zuweisungen Sie ändern möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die Sie ändern möchten. 

3 Aktivieren Sie den Learn-Modus für das Plug-
In. Das Plug-In wird zentriert auf der 
Bedienoberfläche angezeigt.

4 Gehen Sie für jede Parameter-Zuweisung, 
die Sie entfernen möchten, wie folgt vor:

• Stellen Sie sicher, dass im Parameter-Menü No 

Control angezeigt wird. 

• Wählen Sie auf der Bedienoberfläche den 
Drehgeber oder Schalter, dessen Zuweisung Sie 
entfernen möchten, und drehen Sie den Regler 
bzw. drücken Sie den Schalter.

5 Deaktivieren Sie den Learn-Modus für das 
Plug-In.

Speichern von Plug-In-
Zuweisungen
Sie können Plug-In-Zuweisungen als 
Voreinstellungen zur Wiederverwendung auf 
demselben Pro Tools-System speichern. 

Plug-In-Zuweisungen werden als globale 
Voreinstellungen auf einem Pro Tools-System 
gespeichert. Sie sind somit in sämtlichen auf dem 
System erstellten Sessions verfügbar. 

Wenn Sie eine Zuweisung für ein Plug-In erstellen, 
ist diese Zuweisung für alle anderen Plug-Ins 
desselben Typs und Kanalformats verfügbar. 

Sie können Plug-In-Zuweisungen auch zur 
Verwendung in anderen Pro Tools-Systemen mit 
ähnlicher Bedienoberfläche exportieren (siehe 
„Exportieren und Importieren von Plug-In-
Zuweisungen“ auf Seite 1064).

Wenn Sie dasselbe Plug-In in 
unterschiedlichen Kanalformaten zuweisen 
möchten (beispielsweise Mono, Stereo und 
5.1-Surround), müssen Sie eine separate Plug-
In-Zuweisung für jedes Format erstellen.
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So speichern Sie eine Kopie einer 
benutzerdefinierten Plug-In-Zuweisung:

1 Öffnen Sie das Plug-In, dessen Zuweisung Sie 
kopieren möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die Sie kopieren möchten. 

3 Wählen Sie aus dem Map Options-Popup-Menü 
die Option Save Map As. 

4 Geben Sie einen Namen für die Plug-In-
Zuweisung ein.

5 Klicken Sie auf OK. Die neue Kopie wird zur 
aktiven Plug-In-Zuweisung.

So benennen Sie eine benutzerdefinierte Plug-In-
Zuweisung um:

1 Öffnen Sie das Plug-In, dessen Zuweisung Sie 
umbenennen möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die Sie umbenennen möchten. 

3 Wählen Sie im Map Options-Popup-Menü die 
Rename Map-Option. 

4 Geben Sie einen neuen Namen für die Plug-In-
Zuweisung ein.

5 Klicken Sie auf OK.

Löschen von Plug-In-
Zuweisungen
Sie können einzelne Plug-In-Zuweisungen aus 
dem Plug-In-Fenster löschen. 

Zudem können Sie alle benutzerdefinierten Plug-
In-Zuweisungen auf dem System löschen und auf 
diese Weise alle Plug-In-Zuweisungen auf die 
werkseitigen Standardeinstellungen zurücksetzen.

So löschen Sie eine benutzerdefinierte Plug-In-
Zuweisung:

1 Öffnen Sie das Plug-In, dessen Zuweisung Sie 
löschen möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die Sie löschen möchten. 

3 Wählen Sie im Map Options-Popup-Menü die 
Delete Current Map-Option-

4 Klicken Sie auf Delete.

So löschen Sie alle Plug-In-Zuweisungen vom 
System:

1 Öffnen Sie ein beliebiges Plug-In in der 
Session. 

2 Wählen Sie im Map Options-Popup-Menü die 
Delete All Maps-Option.

3 Klicken Sie auf Delete.

Festlegen einer 
benutzerdefinierten Plug-In-
Zuweisung als 
Standardzuweisung
Sie können eine benutzerdefinierte Plug-In-
Zuweisung als Standardzuweisung für ein Plug-In 
festlegen und damit die Zuweisung der 
werkseitigen Standardeinstellungen ersetzen.

Wenn Sie eine benutzerdefinierte Plug-In-
Zuweisung als Standard festlegen, gilt dies für die 
gesamte Session. Alle Instanzen dieses Plug-Ins, 
für die als Zuweisung die werkseitigen 
Standardeinstellungen oder eine andere 
benutzerdefinierte Standardzuweisung festgelegt 
waren, werden entsprechend der neuen 
Standardeinstellung geändert.

Wenn Sie alle Plug-In-Zuweisungen auf 
D-Control- und D-Command-Systemen 
löschen, werden damit auch alle Custom 
Fader-Plug-In-Zuweisungen gelöscht.
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Wenn Sie die Parameter-Zuweisung der 
benutzerdefinierten Plug-In-Zuweisung ändern, 
die als Standardeinstellung gilt, werden diese 
Änderungen in allen Instanzen des Plug-Ins, für die 
diese Standardeinstellung gilt, ebenfalls 
übernommen.

Speicherung standardmäßiger Plug-In-
Zuweisungseinstellungen

Standardmäßige Map-Einstellungen werden als 
globale (für das gesamte System geltende) 
Pro Tools-Voreinstellungen gespeichert und 
werden somit auf alle Sessions angewendet, 
die Sie nach dem Speichern auf diesem System 
öffnen oder erstellen.

So legen Sie eine benutzerdefinierte Plug-In-
Zuweisung als Standard-Plug-In-Zuweisung fest:

1 Öffnen Sie das Plug-In, dessen 
Standardzuweisung Sie ändern möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die als neue Standardeinstellung 
fungieren soll. 

3 Wählen Sie aus dem Map Options-Popup-Menü 
die Set As Default-Option.

Ausblenden der Seiten von 
Standard-Plug-In-Zuweisungen
Wenn Sie eine benutzerdefinierte Plug-In-
Zuweisung erstellen, werden die zugehörigen 
Parameter auf Seiten angeordnet, die den 
Steuerelementgruppen auf der Bedienoberfläche 
entsprechen. 

Wenn Sie durch die Steuerelemente eines Plug-Ins 
auf einer Bedienoberfläche blättern, werden die 
benutzerdefinierten Plug-In-Zuweisungen zuerst 
angezeigt. Die Seiten mit den Zuweisungen der 
werkseitigen Standardeinstellungen werden nach 
den benutzerdefinierten Seiten angezeigt.

Sie können die Seiten mit den werkseitigen 
Standardeinstellungen eines Plug-Ins ausblenden, 
sodass auf der Bedienoberfläche nur die 
benutzerdefinierten Seiten angezeigt werden. Dies 
gilt für sämtliche Instanzen des Plug-Ins. 

So blenden Sie die Seiten mit den werkseitigen 
Standardeinstellungen eines Plug-Ins aus:

1 Öffnen Sie das Plug-In, dessen Standardseiten 
für Plug-In-Zuweisungen Sie ändern möchten.

2 Wählen Sie aus dem Map Options-Popup-Menü 
die Hide Factory Default Pages-Option.

Exportieren und Importieren 
von Plug-In-Zuweisungen
Plug-In-Zuweisungen können als PIM-Dateien 
exportiert und auf anderen Pro Tools-Systemen 
verwendet werden. 

Beim Exportieren von Plug-In-Zuweisungen 
können Sie wählen, ob Sie verschiedene 
Zuweisungsdateien für die einzelnen Plug-Ins oder 
eine einzige Zuordnungsdatei mit sämtlichen Plug-
In-Zuweisungen für das System speichern möchten. 

Wenn Sie eine Plug-In-Zuweisung exportieren, 
wird die standardmäßige Map-Einstellung für 
dieses Plug-In ebenfalls exportiert. 
Die Standardeinstellung wird nach dem 
Importieren der Zuweisung aktualisiert und alle 
Instanzen des Plug-Ins werden entsprechend 
der neuen Standardeinstellung geändert. 

Wenn Sie in mehreren Sessions mit derselben 
Plug-In-Zuweisung arbeiten möchten, 
sichern Sie Ihre Einstellungen, indem Sie alle 
Plug-In-Zuweisungen in regelmäßigen 
Abständen exportieren und die PIM-Datei 
mit Ihren Sessions speichern.
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So exportieren Sie eine einzelne Plug-In-Zuweisung:

1 Öffnen Sie das Plug-In, dessen Zuweisung Sie 
exportieren möchten.

2 Wählen Sie im Map Presets-Popup-Menü die 
Zuweisung, die Sie exportieren möchten. 

3 Wählen Sie im Map Options-Popup-Menü die 
Export Current Plug-In Map-Option.

4 Wählen Sie einen Speicherort für die Map-
Datei aus.

5 Klicken Sie auf Save. 

So exportieren Sie alle Plug-In-Zuweisungen des 
Systems in eine einzige Map-Datei:

1 Öffnen Sie ein beliebiges Plug-In in der 
Session. 

2 Wählen Sie im Map Options-Popup-Menü die 
Export All Plug-In Maps-Option .

3 Wählen Sie einen Speicherort für die Map-
Datei aus.

4 Klicken Sie auf Save. 

So importieren Sie eine Map-Datei:

1 Öffnen Sie das Plug-In, für das Sie eine Plug-In-
Zuweisung importieren möchten.

2 Wählen Sie im Map Options-Popup-Menü die 
Import Plug-In Maps From File-Option.

3 Suchen Sie die PIM-Datei mit der Plug-In-
Zuweisung, die Sie importieren möchten. 

4 Klicken Sie auf Open.

Bypass-Schaltung von Plug-Ins
Plug-Ins können vom dazugehörigen Plug-In-
Fenster aus auf Bypass geschaltet werden. Dies ist 
auch vom Inserts-Bedienfeld im Mix- oder Edit-
Fenster aus möglich. 

Führen Sie einen der folgenden Schritte aus, um 
ein Plug-In auf Bypass zu schalten:

 Klicken Sie im Plug-In-Fenster auf die Effect 
Bypass-Schaltfläche

 Klicken Sie bei gedrückter Strg- (Windows) 
bzw. Befehlstaste (Mac) auf die Insert-
Schaltfläche des Plug-Ins im Mix- bzw. Edit-
Fenster. 

Wenn ein Plug-In auf Bypass geschaltet ist, wird 
die zugehörige Insert-Schaltfläche blau. Wenn nur 
einige der Kanäle eines Multimono-Plug-Ins auf 
Bypass geschaltet sind, wird die zugehörige Insert-
Schaltfläche violett.

So umgehen Sie bestimmte Inserts über das Spur-
Menü:

1 Wählen Sie die Spuren aus, für die Sie Inserts 
umgehen möchten. Klicken Sie bei gedrückter 
Wahltaste (Mac) oder Alt-Taste (Windows) auf 
alle für die Session angezeigten Spuren.

2 Wählen Sie Track > Bypass Insert.

Wenn Sie alle Plug-In-Zuweisungen auf 
D-Control- und D-Command-Systemen 
exportieren, werden damit auch alle Custom 
Fader-Plug-In-Zuweisungen in dieselbe 
Datei exportiert. Weitere Informationen 
finden Sie im D-Control-Handbuch oder im 
D-Command-Handbuch.

Kennzeichnung des Bypass-Status von Plug-Ins

auf Bypass 
geschaltet (blau)

nicht auf Bypass
geschaltet
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3 Aktivieren (oder deaktivieren) Sie eine der 
folgenden Optionen:

All. – Bypass für sämtliche Inserts für alle 
ausgewählten Spuren einer Session.

Inserts A–E. – Bypass für Inserts A-E für alle 
ausgewählten Spuren der Session.

Inserts F–J. – Bypass für Inserts A-E für alle 
ausgewählten Spuren der Session.

EQ. – Bypass für alle EQ-Plug-Ins für sämtliche 
ausgewählten Spuren der Session. Bei Plug-Ins, 
die in mehreren Kategorien verfügbar sind (z. B. 
Channel Strip) wird der Bypass nur der EQ-Teil 
des Plug-Ins aktiv.

Dynamics. – Bypass für sämtliche Dynamics-
Plug-Ins für alle ausgewählten Spuren der Session. 
Bei Plug-Ins, die in mehreren Kategorien 
verfügbar sind (z. B. Channel Strip) wird der 
Bypass nur der Dynamics-Teil des Plug-Ins aktiv.

Reverb. – Bypass für sämtliche Reverb-Plug-Ins 
für alle ausgewählten Spuren der Session.

Delay. – Bypass für sämtliche Delay-Plug-Ins für 
alle ausgewählten Spuren der Session.

Modulation. – Bypass für sämtliche Modulation-
Plug-Ins für alle ausgewählten Spuren der Session.

Tastaturbefehle zum Umgehen von 
Inserts

Pro Tools bietet Tasten-/Mausbefehle zum 
Umgehen von Inserts für ausgewählte Spuren im 
Mix-Fenster:

 Klicken Sie bei gedrückter Befehlstaste (Mac) 
oder Starttaste (Windows) im Mix- oder Edit-
Fenster auf eine Insert-Zuweisungs-Schaltfläche, 
um den Bypass für diesen und alle nachfolgenden 
Inserts für eine Spur zu aktivieren.

 Klicken Sie bei gedrückter Befehls- und 
Wahltaste (Mac) oder Starttaste (Windows) im 
Mix- oder Edit-Fenster auf eine Insert-
Zuweisungs-Schaltfläche, um den Bypass für 
diesen und alle nachfolgenden Inserts für 
sämtliche Spuren zu aktivieren. So können Sie alle 
Inserts Ihrer Session mit einem Klick umgehen.

 Drücken Sie Umschalt + A, um den Bypass für 
alle Inserts für ausgewählte Spuren zu aktivieren 
(bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + 1, um den Bypass für 
die Inserts A-E für ausgewählte Spuren zu 
aktivieren (bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + 2, um den Bypass für 
die Inserts F-J für ausgewählte Spuren zu 
aktivieren (bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + E, um den Typ für alle 
EQ-Plug-Ins für ausgewählte Spuren zu aktivieren 
(bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + C, um den Bypass für 
alle Dynamics-Plug-Ins für ausgewählte Spuren zu 
aktivieren (bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + V, um den Bypass für 
alle Reverb-Plug-Ins für ausgewählte Spuren zu 
aktivieren (bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + D, um den Bypass für 
alle Delay-Plug-Ins für ausgewählte Spuren zu 
aktivieren (bzw. die Aktivierung aufzuheben).

 Drücken Sie Umschalt + W, um den Bypass für 
alle Modulation-Plug-Ins für ausgewählte Spuren 
zu aktivieren (bzw. die Aktivierung aufzuheben).
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Koppeln der Steuerelemente 
von Multimono-Plug-Ins und 
Aufheben der Koppelung
Wenn ein Multimono-Plug-In auf einer Stereospur 
oder einer Mehrkanalspur angewendet wird (nur 
Pro Tools HD), sind die Steuerelemente 
standardmäßig miteinander gekoppelt. Wenn dann 
etwa das Gain-Steuerelement auf einem Kanal 
verschoben wird, wird es gleichzeitig für alle 
anderen Kanäle eingestellt.

Sie können die Koppelung von Multimono-Plug-
In-Steuerelementen auf bestimmten Kanälen einer 
Spur aufheben und die Plug-Ins unabhängig 
voneinander editieren. Sie können auch die 
Steuerelemente bestimmter Kanäle selektiv 
koppeln.

So entkoppeln Sie Steuerelemente in einem 
Multimono-Plug-In:

 Deaktivieren Sie die Master Link-Schaltfläche.

So greifen Sie auf Steuerelemente für einen 
bestimmten Kanal zu:

 Wählen Sie über den Channel-Selektor den 
gewünschten Kanal aus.

So koppeln Sie die Steuerelemente bestimmter 
Kanäle:

1 Deaktivieren Sie die Master Link-Schaltfläche, 
sofern Sie das nicht bereits getan haben.

2 Klicken Sie auf die Link Enable-Schaltflächen 
für die Kanäle, deren Steuerelemente Sie 
koppeln möchten. 

Verwenden von Hardware-
Inserts
Sie können externe Geräte, wie etwa Hall- oder 
Effektprozessoren, an das Pro Tools-System 
anschließen und sie als Hardware-Inserts auf 
einzelne Spuren oder Submixe anwenden.

Pro Tools-Inserts verwenden entsprechende 
Hardware-Eingangskanäle und -Ausgangskanäle, 
um Audiosignale zu senden und zurückzuführen. 
Im I/O Setup-Dialogfeld auf der Insert-
Registerkarte können Inserts definiert und die 
dazugehörigen Kanäle Audio-Interface-Kanälen 
zugewiesen werden. 

Wenn Sie ein Gerät als Insert benutzen möchten, 
muss es über passende Eingänge und Ausgänge 
mit Ihrem System verbunden sein. Beispiel: Ein 
Hardware-Insert, das von den Ausgängen 7–8 
ausgeht, muss an die Hardware-Eingänge 7–8 
zurückgegeben werden. 

So definieren Sie Hardware-Inserts:

1 Wählen Sie Setup > I/O und klicken Sie dann 
auf die Insert-Registerkarte. 

2 Wählen Sie einen Insert-Pfad oder klicken 
Sie auf New Path, um einen neuen Insert-Pfad 
zu erstellen.

Channel-Selektor und Link-Steuerelemente 
(mit deaktivierter Link-Schaltfläche)

Channel-Selektor

Link Enable (Schaltflächen)

Master Link (Schaltfläche)

Alle Kanäle gekoppelt, außer LFE

Verzögerungsausgleich kann auf Hardware-
Inserts angewendet werden. Siehe „H/W 
Insert Delay (Compensation)-Registerkarte“ 
auf Seite 75.
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3 Doppelklicken Sie auf den Pfadnamen, 
um einen benutzerdefinierten Pfadnamen für 
den Insert einzugeben.

4 Dazu muss der Insert-Pfad auf das richtige 
Format eingestellt sein (Mono, Stereo oder ein 
anderes).

5 Weisen Sie die Inserts in der Kanalmatrix nach 
Bedarf zu. Für Insert- und Output-Pfade gibt es 
besondere Regeln hinsichtlich der 
Kanalzuweisung (siehe „Gültige Pfade und 
Voraussetzungen“ auf Seite 95).

Zuweisen von Hardware-Inserts

So weisen Sie einer Spur einen externen 
Hardware-Insert zu:

 Wählen Sie aus dem Insert-Selektor der Spur 
einen Insert. 

Bypass von Hardware-Inserts
Für Hardware-Inserts gibt es keine Bypass-
Steuerelemente. Um die Wiedergabe ohne ein 
Hardware-Insert abzuhören, setzen Sie dieses 
entweder auf „Inactive“, entfernen Sie es durch 
Neuzuweisung auf „No Insert“ oder betätigen Sie 
einen Bypass-Schalter auf dem Hardware-Gerät 
selbst. (Weitere Informationen hierzu finden Sie 
unter „Deaktivieren von Inserts“ auf Seite 1041.)

Anschließen und Integrieren von 
externen Geräten
Pro Tools kann spezielle Verbindungen zu 
externen Analog- oder Digitalgeräten erstellen. 
Die Anzahl und die Art der Verbindungen hängt 
von Ihrem System ab.

So schließen Sie ein externes Gerät an ein 
Pro Tools-System an: 

1 Verbinden Sie einen freien Ausgang (oder bei 
einem Stereogerät ein Ausgangspaar) Ihres 
Pro Tools-Systems mit dem Eingang eines 
externen Signalprozessors.

2 Verbinden Sie den Ausgang des externen 
Signalprozessors mit einem ungenutzten 
Eingang (oder einem Eingangspaar bei einem 
Stereogerät) Ihres Pro Tools-Systems.

3 Legen Sie im Hardware Setup- bzw. I/O Setup-
Dialogfeld fest, welche physischen Ports auf die 
Eingänge und Ausgänge in Pro Tools geroutet 
werden sollen.

4 Legen Sie im I/O Setup-Dialogfeld die 
gewünschten Einstellungen für Ausgangs-, 
Eingangs- oder Insert-Pfade fest. 

Wenn Sie ein Gerät als Insert benutzen möchten, 
muss es über passende Eingänge und Ausgänge 
mit Ihrem System verbunden sein. Um die 
Ausgänge 7–8 verwenden zu können, muss der 
Insert auch die Eingänge 7–8 verwenden. 

Auswählen eines Hardware-I/O-Insert

Hardware Insert-Fenster

Weitere Informationen zum Anschließen von 
externen Geräten finden Sie im 
Benutzerhandbuch zu Ihrem System.
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Anschließen von Effektgeräten 
auf der digitalen Ebene
Wenn Sie die digitalen Eingänge und Ausgänge 
auf Ihrem Pro Tools-System als Effekt-Sends und 
-Returns zu einem digitalen Effektgerät nutzen 
möchten, empfiehlt es sich meistens, die Clock in 
Pro Tools als Master zu verwenden. Stellen Sie 
Ihren digitalen Effekterzeuger so ein, dass ein 
externer digitaler Taktgeber akzeptiert wird, damit 
das Effektgerät mit Pro Tools synchronisiert ist.

So richten Sie einen digitalen Send von einem 
Pro Tools|HDX- oder Pro Tools|HD Native-System 
zu einem externen Gerät ein:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie das Audio-Interface aus der 
Peripherals-Liste (HD I/O, HD MADI oder 
HD OMNI).

3 Wählen Sie ein Audio- und ein Clock-Format 
und setzen Sie das entsprechende Kanalpaar auf 
Digital.

4 Wählen Sie im Clock Source-Popup-Menü die 
Internal-Option.

5 Klicken Sie auf OK. 

So richten Sie einen digitalen Send von einem 
Pro Tools-System mit 003, 003 Rack+ oder 
003 Rack zu einem externen Gerät ein:

1 Wählen Sie Setup > Playback Engine und das 
Peripheriegerät.

2 Sie haben folgende Möglichkeiten:

• Wenn das externe Gerät mit den S/PDIF-RCA-
Klinkensteckern verbunden ist, deaktivieren Sie 
„S/PDIF Mirroring“. (Wenn „S/PDIF 
Mirroring“ aktiv ist, spiegelt der digitale 
Ausgang an den S/PDIF-RCA-Klinkensteckern 
den Ausgang der Analogkanäle 1–2.)

• Wenn das externe Gerät an die optischen Ports 
angeschlossen ist, wählen Sie im Optical 
Format-Popup-Menü ein Format aus (für ein 
Effektgerät wahrscheinlich „S/PDIF“).

3 Wählen Sie im Clock Source-Popup-Menü 
Internal.

4 Klicken Sie auf OK.

5 Auf Wunsch können Sie das I/O Setup-
Dialogfeld auch mit neuen Pfadnamen für 
Effekt-Routing konfigurieren. 

Externe Taktgeber (zum 
Aufnehmen und Abhören)
Alle Pro Tools-Systeme können mit einem 
externen Taktgeber bei der Aufnahme oder beim 
Abhören synchronisiert werden. Die Optionen 
dafür variieren und hängen vom verwendeten 
Pro Tools-System ab.

Nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme

Pro Tools|HDX- und Pro Tools|HD Native-
Systeme können externen Takt über beliebige 
digitale Eingänge beliebiger Avid HD-Audio-
Interfaces empfangen (einschließlich AES/EBU, 
S/PDIF und Optical).

Wenn Sie „Optical Format“ auf „S/PDIF“ 
einstellen, kontrolliert Pro Tools den 
optischen Port auf Audioeingänge, 
ignoriert jedoch Audioeingänge über die 
S/PDIF-RCA-Klinkenstecker.

Weitere Informationen zu Audio-Interface-
Verbindungen finden Sie im Handbuch zu 
Ihrem Audio-Interface.
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So wählen Sie einen externen Taktgeber für 
Pro Tools|HDX- oder Pro Tools|HD Native-Systeme:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie das entsprechende Audio-Interface, 
um seine Einstellungen auf der Main-
Registerkarte anzuzeigen.

3 Wählen Sie gegebenenfalls das passende 
digitale Format (falls Sie dies nicht bereits 
getan haben, wie im Benutzerhandbuch oder 
I/O-Handbuch beschrieben).

4 Stellen Sie für Clock Source den passenden 
Eingang ein.

5 Konfigurieren Sie das Eingangs-Routing der 
digitalen Quelle, wenn nötig mithilfe der Input- 
und Output-Popup-Menüs.

6 Klicken Sie auf OK, um das Hardware Setup-
Dialogfeld zu schließen.

Pro Tools-Systeme mit 003, 003 Rack+ oder 
003 Rack

Pro Tools kann externe Taktsignale über den 
optischen oder den S/PDIF-Eingang empfangen.

So wählen Sie einen externen Taktgeber für ein 
Pro Tools-System mit 003, 003 Rack+ oder 003 Rack:

1 Wählen Sie Setup > Hardware.

2 Stellen Sie für Clock Source den passenden 
Eingang ein.

3 Wenn Sie Optical wählen, muss Optical Format 
mit dem Typ des optischen Eingangs 
übereinstimmen, den Sie an Ihr Pro Tools-
System senden. 

Pro Tools-Systeme mit Eleven Rack

Pro Tools kann externe Taktsignale über den 
AES/EBU-Eingang oder den S/PDIF-Eingang 
empfangen.

So wählen Sie einen externen Taktgeber für 
Eleven Rack:

1 Wählen Sie Setup > Hardware.

2 Stellen Sie für Clock Source den passenden 
Eingang ein.

Pro Tools-Systeme mit Mbox Pro, Mbox 2 Pro, 
Mbox (3. Generation) oder Mbox 2

Pro Tools kann externe Taktsignale über den 
S/PDIF-Eingang dieser Interfaces empfangen.

So wählen Sie einen externen Taktgeber für ein 
Pro Tools-System mit Mbox Pro, Mbox 2 Pro, 
Mbox (3. Generation) oder Mbox 2:

1 Wählen Sie Setup > Hardware.

2 Wählen Sie SPDIF (Windows) bzw. 
SPDIF/RCA (Mac) aus dem Clock Source-
Popup-Menü. 

3 Klicken Sie auf OK.

Wenn Sie „Optical Format“ auf „S/PDIF“ 
einstellen, überprüft Pro Tools den 
optischen Port auf externe Taktgeber und 
ignoriert jeden Clock-Eingang über die 
S/PDIF-RCA-Klinkenstecker.

Zur Synchronisation muss das digitale 
Eingabegerät eingeschaltet und mit 
Pro Tools verbunden sein. Wenn Ihr 
Eingabegerät nicht eingeschaltet ist, 
behalten Sie für „Clock Source“ die 
Internal-Einstellung bei.
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Kapitel 45: Automation

Pro Tools ermöglicht die dynamische Automation 
von Mixing-Einstellungen auf den einzelnen 
Spurarten. Sie können Automationsbewegungen 
aufzeichnen und sie in Echtzeit während der 
Wiedergabe und Aufzeichnung in Ihrer Session 
anzeigen. Sie können Automationsdaten auch mit 
denselben Methoden editieren, die Sie für Audio- 
und MIDI-Daten verwenden.

Automationsgenauigkeit bei 
Bedienoberflächen
Bedienoberflächen. – die Bedienoberflächen 
D-Control, D-Command, ProControl, C|24 und 
Command|8 (sowie 003) unterstützen die 
Automationsfunktionen in Pro Tools. Die 
Bedienoberflächen von Pro Tools bieten eine 
10-Bit-Auflösung bzw. eine Fader-Auflösung 
von 1.024 Schritten. Während der Wiedergabe 
interpoliert Pro Tools diese Eingangsdaten in 
eine 24-Bit-Auflösung, was zu einer genauen 
und nahtlosen Fader-Automation führt.

EUCON. – Avid-Bedienoberflächen, die EUCON 
verwenden, bieten eine Schiebe- und 
Drehreglersteuerung mit einer 12-Bit-Auflösung.

MIDI-Bedienoberflächen. – die MIDI-
Bedienoberflächen bieten eine 7-Bit-Auflösung 
bzw. 128 Schritte. Während der Wiedergabe 
interpoliert Pro Tools diese Eingangsdaten in eine 
24-Bit-Auflösung, was zu einer genauen und 
nahtlosen Fader-Automation führt.

Automation – Übersicht
Pro Tools bietet viele Optionen zum Aufnehmen, 
Ersetzen und Editieren von Automationsdaten. 

Die grundlegenden Schritte zur 
Automationsaufzeichnung sind wie folgt:

• Aktivieren Sie den Automationstyp, den Sie 
aufzeichnen möchten (Automation für 
Lautstärke, Panorama, Send-Pegel, Send-
Panorama, Send-Stummschaltung oder Plug-Ins). 

• Versetzen Sie die entsprechenden Spuren in 
einen Modus für die Automationsaufzeichnung 
(Write-, Touch-, Latch- oder einen Trim-
Modus). 

• Wenn Sie ein Plug-In automatisieren, aktivieren 
Sie die jeweiligen Steuerelemente für die Plug-
In-Automation.

• Wenn Sie Plug-Ins, Ausgänge oder Sends, 
für die es bereits Automationsdaten gibt, vor 
dem Überschreiben schützen möchten, wenden 
Sie auf alle die Automation Safe-Option an. 

• Starten Sie die Wiedergabe, um mit der 
Automationsaufzeichnung zu beginnen, 
und passen Sie die Einstellungen bei Bedarf an. 
Pro Tools speichert alle Bewegungen, die auf 
aktivierten Parametern ausgeführt wurden. 

Weitere Informationen zur Verwendung 
von Bedienoberflächen für die 
Mischautomation finden Sie in Ihrem 
Handbuch zur Bedienoberfläche.
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Zum Editieren von Automation nach der 
Aufzeichnung haben Sie folgende Möglichkeiten:

• Wiederholen Sie die oben genannten Schritte, 
um die ursprünglichen Daten mit neuen 
Automationsdaten zu überschreiben.

• Editieren Sie die Automationsdaten im Edit-
Fenster grafisch.

• Sie können Automationsdaten ausschneiden, 
kopieren und einfügen oder löschen (es gibt 
bestimmte Einschränkungen).

Automations-Playlists
Jede Pro Tools-Spur enthält für jeden 
automatisierbaren Parameter eine Automations-
Playlist.

Auf Audiospuren sind dies folgende Parameter:

• Volume

• Volume Trim (nur Pro Tools HD)

• Pan

• Stummschaltung

• Send Level

• Send Level Trim (nur Pro Tools HD)

• Send Pan

• Send Mute

• Plug-In-Steuerelemente

Auf Auxiliary-Eingangs-Spuren sind dies 
folgende Parameter:

• Volume

• Volume Trim (nur Pro Tools HD)

• Stummschaltung

• Pan

Auf Master-Fadern sind dies folgende Parameter:

• Volume

• Volume Trim (nur Pro Tools HD)

• Auf MIDI-Spuren sind dies folgende Parameter:

• MIDI Volume

• MIDI Pan

• MIDI Mute

Auf Instrumentenspuren sind dies folgende 
Parameter:

• Volume (Audio)

• Volume Trim (Audio, nur Pro Tools HD)

• Mute (Audio)

• Pan (Audio)

Auf VCA Master-Spuren (nur Pro Tools HD) sind 
dies folgende Parameter:

• Volume

• Volume Trim

• Stummschaltung

Sie können jede dieser automatisierbaren Playlists 
einzeln in Pro Tools darstellen und editieren; dies 
ist auch während der Wiedergabe möglich.

Darüber hinaus können Sie auf MIDI- und 
Instrumentenspuren andere MIDI-Daten von 
Continuous Controllern (etwa Modulationsrad, 
Blaswandler, Fußschalter oder Sustain) in 
ähnlicher Weise anzeigen und editieren. Weitere 
Informationen zum Editieren von MIDI-Daten 
finden Sie unter „Continuous Controller-Events“ 
auf Seite 712.
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Automations-Playlists mit 
Audio- und MIDI-Clips
Pro Tools behandelt Audioclips und deren 
Automations-Playlists anders als MIDI-Clips und 
deren Automations-Playlists.

Audiospuren

Die Automationsdaten von Audiospuren befinden 
sich in einer separaten Playlist, getrennt von 
Audiodaten und -clips. Alle Edit-Playlists auf 
einer Audiospur verwenden dieselben 
Automationsdaten. 

MIDI- und Instrumentenspuren

Auf MIDI- und Instrumentenspuren werden alle 
Automationsdaten mit Ausnahme der Daten zur 
MIDI- oder Audio-Stummschaltung (nur 
Instrumentenspuren) in dem MIDI-Clip 
gespeichert, der die Daten enthält. Jede Edit-
Playlist auf einer Spur ist separat zu betrachten und 
repräsentiert einen getrennten Arbeitsgang samt 
Controller-Automation. 

Trim-Automations-Playlists
(Nur Pro Tools HD)

Separate Trim-Automations-Playlists sind zum 
Trimmen der Lautstärke (Volume) und des Send-
Pegels (Send Level) verfügbar. Volume-Trim ist 
auf allen Spurarten mit Ausnahme von MIDI-
Spuren verfügbar. Send Level-Trim ist nur auf 
Audiospuren verfügbar. 

Jede Trim-Automations-Playlist zeigt die Position 
des Trim-Faders mit gelber Breakpoint-
Automation an, die bearbeitet werden kann. 
Weitere Informationen zu Trim-Playlists finden 
Sie unter „Trim-Modus“ auf Seite 1077 und 
„Darstellen von Automationsdaten“ auf 
Seite 1081. 

Mehrere Edit-Playlists und 
Audiospur-Automation 
Alle Edit-Playlists auf einer Audiospur verwenden 
dieselben Automationsdaten. Wenn Sie 
Automationsdaten in einer Audiospur aufzeichnen 
oder editieren, werden sie in der entsprechenden 
Automations-Playlist der Spur gespeichert, sodass 
sie mit den dazugehörigen Audioclips oder 
unabhängig davon bearbeitet werden können. 

 Wenn Sie Audiodaten aus einer Spur in der 
Waveform-Darstellung kopieren oder 
ausschneiden, werden die zugrunde liegenden 
Automationsdaten ebenfalls ausgeschnitten bzw. 
kopiert. 

 Wenn Sie Audiodaten von anderen Positionen 
oder Spuren in eine Edit-Playlist einfügen, können 
sich die zugrunde liegenden Automationsdaten auf 
der Spur ändern. 

 Wenn Sie Clips mit dem Trim-Befehl (Edit > 

Trim) bearbeiten, bleiben die zugrunde liegenden 
Automationsdaten unverändert. 

MIDI-Stummschaltungsdaten sind von 
den MIDI-Daten in einem MIDI-Clip 
unabhängig. Dies gibt Ihnen die 
Möglichkeit, einzelne MIDI- oder 
Instrumentenspuren in Pro Tools ohne 
Änderung der Controller-Daten 
stummzuschalten. 

MIDI-Continuous Controller-Daten folgen 
immer dem Editieren von Clips, 
ausgenommen bei der Stummschaltung. 
Weitere Hinweise finden Sie unter „MIDI- 
und Instrumentenspuren“ auf Seite 1073.

Weitere Informationen finden Sie unter 
„Editieren von Automationsdaten“ auf 
Seite 1102.
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Duplizieren von Spuren zum 
Editieren von Playlists
Der Duplicate Track-Befehl bietet eine praktische 
Möglichkeit, eine Arbeitskopie von einer Spur 
anzufertigen, um mit Routing, Plug-Ins und 
Automation zu experimentieren. Die Originalspur 
und ihre Automationsdaten werden dadurch vor 
Änderungen und dem Überschreiben geschützt. 

Automationsmodi
Automationsmodi steuern die Speicherung und 
Wiedergabe der Automationsdaten einer Spur. Für 
jede Spur gibt es einen Automation Mode-Selektor 
zum Auswählen des Automationsmodus für die 
Spur.

Off-Modus
Im Off-Modus wird die Automation für alle 
automatisierbaren Parameter ausgeschaltet:

• Volume

• Pan

• Stummschaltung

• Send-Lautstärke, -Panorama und 
-Stummschaltung

• Plug-In-Steuerelemente

• MIDI-Lautstärke, -Panorama und 
-Stummschaltung

Im Off-Modus werden Automationsdaten für diese 
Parameter während der Wiedergabe nicht 
beachtet. Alle anderen MIDI-Controller-Daten 
werden übertragen. 

Die Automation kann während der Wiedergabe 
oder Aufzeichnung vom Off-Modus in einen 
anderen Automationsmodus geschaltet werden.

Read-Modus
Im Read-Modus werden Automationsdaten 
abgespielt, die vorher für eine Spur geschrieben 
wurden.

Write-Modus
Im Write-Modus werden vom Beginn bis zum 
Ende der Wiedergabe Automationsdaten 
geschrieben. Dabei wird die zuvor für diesen 
Abschnitt des Automationsdurchgangs 
aufgezeichnete Automation gelöscht. 

AutoMatch kann auf einen Write-
Automationsdurchgang angewendet werden. 
Siehe „AutoMatch Time“ auf Seite 1080.

After Write Pass, Switch To-Option

Sie können Pro Tools so einrichten, dass nach 
Abschluss eines Automationsdurchgangs im 
Write-Modus automatisch ein Wechsel in den 
Touch- oder Latch-Modus erfolgt oder der Write-
Modus beibehalten wird.

So richten Sie den Automationsmodus nach 
einem Write-Durchgang ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Wählen Sie unter „Automation“ eine Option für 
After Write Pass, Switch To aus (Touch, Latch 
oder No Change).

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

Weitere Informationen finden Sie unter 
„Duplizieren von Spuren“ auf Seite 224.
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Touch-Modus
Im Touch-Modus werden nur dann 
Automationsdaten geschrieben, wenn Sie einen 
Fader oder Schalter berühren bzw. mit der Maus 
darauf klicken. Wenn Sie den Fader loslassen, 
wird die Aufzeichnung der Automation gestoppt 
und der Fader kehrt auf die zuvor automatisierte 
Position zurück. Wann und wie dies geschieht, 
wird durch die AutoMatch- und Touch Timeout-
Einstellungen bestimmt. Siehe „Automation-
Voreinstellungen“ auf Seite 1079.

Im Touch-Modus beginnen bestimmte 
Bedienoberflächen mit der Aufzeichnung, sobald 
Sie die entsprechenden Bedienelemente berühren. 
Dazu gehören berührungsempfindliche, 
motorisierte Fader auf D-Control, D-Command, 
ProControl, C|24, 003 oder Command|8.

Bei anderen Bedienoberflächen beginnt die 
Automationsaufzeichnung im Touch-Modus erst, 
wenn der Fader den Durchgangspunkt oder die 
zuvor automatisierte Position erreicht hat. Sobald 
Sie mit dem Fader oder einem nicht 
berührungsempfindlichen Drehregler am 
Durchgangspunkt angekommen sind, startet die 
Aufzeichnung und stoppt erst, wenn Sie den Fader 
bzw. Regler nicht mehr bewegen.

Latch-Modus
Der Latch-Modus funktioniert auf die gleiche 
Weise wie der Touch-Modus, d. h. 
Automationsdaten werden nur dann aufgezeichnet, 
wenn Sie ein Bedienelement berühren oder 
bewegen. Im Gegensatz zum Touch-Modus wird 
hier jedoch die Aufzeichnung so lange fortgesetzt, 
bis Sie die Wiedergabe anhalten oder ein „Punch-
Out“ auf dem Automationsdurchgang ausführen, 
indem Sie den Automationsmodus auf „Read or 
Touch“ ändern.

AutoMatch kann auf einen Latch-
Automationsdurchgang angewendet werden. 
Siehe „AutoMatch Time“ auf Seite 1080.

Der Latch-Modus ist besonders nützlich zum 
Automatisieren von Panoramareglern, Plug-Ins 
und nicht berührungsempfindlichen Drehreglern, 
da es in diesem Modus keine Zeitbegrenzung gibt 
und der Regler beim Loslassen nicht auf seine 
vorherige Position zurückgesetzt wird. 

AutoJoin und Latch-Modus
(Nur Pro Tools HD)

Pro Tools verfügt über zwei verschiedene 
Methoden, die Automationsaufzeichnung auf 
Bedienelementen, die zum Zeitpunkt des 
Anhaltens des Transports aktiv waren, 
fortzusetzen:

AutoJoin. – mit dieser Option können Sie die 
Automationsaufzeichnung im Latch-Modus 
automatisch fortsetzen.

Join. – mit dieser Option können Sie die 
Automationsaufzeichnung im Latch-Modus 
manuell fortsetzen. Die Join-Funktion ist nur in 
Verbindung mit unterstützten Bedienoberflächen 
verfügbar.

Siehe auch „Schreiben von Automation bis 
zum Anfang, Ende oder für eine gesamte Spur 
oder eine Selektion“ auf Seite 1114.
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So aktivieren Sie die AutoJoin-Funktion in 
Pro Tools:

1 Wählen Sie Window > Automation.

2 Klicken Sie auf die AutoJoin-Schaltfläche.

AutoJoin-Anzeige

Nach einem Automationsdurchgang im Latch-
Modus und bei aktivierter AutoJoin-Funktion ist 
im Edit-Fenster von Pro Tools die AutoJoin-
Anzeige zu sehen.

Die AutoJoin-Anzeige ist eine vertikale Linie, 
die den Punkt kennzeichnet, an dem der letzte 
Automationsdurchgang angehalten wurde, 
und den Punkt, an dem der Join-Vorgang für alle 
Spuren, die während dieses vorangegangenen 
Durchgangs aufzeichneten, automatisch 
stattfindet. Wird die Automationsaufzeichnung 
von diesem Punkt aus fortgesetzt, wird die rote 
Linie nicht mehr angezeigt.

AutoJoin Enable-Schaltfläche im Automation-Fenster

Weitere Informationen zur Verwendung der 
Funktionen„Join“und„AutoJoin“ in 
Verbindung mit einer Bedienoberfläche finden 
Sie im Handbuch zur entsprechenden 
Bedienoberfläche.

AutoJoin-Anzeige im Edit-Fenster

Starten Sie den Transport vor der 
AutoJoin-Anzeige neu, um die Join- oder 
AutoJoin-Funktion zum Fortsetzen der 
Automationsaufzeichnung für 
Bedienelemente zu verwenden, die zum 
Zeitpunkt des Stoppens des Transports 
aufzeichneten.
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Touch/Latch-Modus
(Nur Pro Tools HD)

Mit dem Touch/Latch-Automationsmodus wird 
die Lautstärkeregelung einer Spur in den Touch-
Modus versetzt und alle anderen automatisierbaren 
Bedienelemente werden in den Latch-Modus 
versetzt. 

Im Touch/Latch-Modus folgt der Lautstärkeregler 
dem Touch-Verhalten. Dabei zeichnet er auf 
Berührung hin die Automation auf und kehrt zu 
zuvor geschriebenen Pegeln zurück, wenn er 
losgelassen wird. 

Alle anderen Bedienelemente folgen dem Latch-
Verhalten und zeichnen die Automation auf, 
wenn sie berührt werden; die Aufzeichnung wird 
fortgesetzt, bis die Wiedergabe anhält oder Sie 
aus der Automationsaufzeichnung aussteigen 
(Punch-Out).

Trim-Modus
(Nur Pro Tools HD)

Pro Tools HD-Systeme können bestehende 
Automationsdaten für Spurlautstärke und Send-
Pegel in Echtzeit anpassen (oder trimmen). 
Panorama-, Stummschaltungs- und Plug-In-
Automation kann nicht auf diese Weise getrimmt 
werden. Der Trim-Modus arbeitet zusammen mit 
den anderen Automationsmodi („Read“, „Touch“, 
„Latch“, „Touch/Latch“ und „Write“) und kommt 
zum Einsatz, wenn Sie alle automatisierten 
Lautstärkeänderungen beibehalten möchten, 
die Pegel aber insgesamt etwas lauter oder leiser 
stellen müssen, um die Balance einer Mischung zu 
regeln. Weitere Informationen finden Sie unter 
„Trim-Automationsmodi“ auf Seite 1077.

Beim Schreiben von Automationsdaten im Trim-
Modus schreiben Fader-Bewegungen relative statt 
absolute Werte. Vorhandene Automationsdaten 
werden um den von den Fadern angezeigten 
Differenzwert (d. h. die Zunahme oder Abnahme, 
den sogenannten Deltawert) verändert. 

Wenn der Trim-Modus aktiviert ist, verhalten sich 
nicht trimmbare Parameter genauso wie in den 
Standard-Automationsmodi, mit Ausnahme des 
Write/Trim-Modus, in dem nicht trimmbare 
Parameter wie im Touch-Modus funktionieren.

Trim-Automationsmodi
Wenn sich eine Spur in einem Trim-
Automationsmodus befindet (ausgenommen 
„Trim Off“), werden ihre Main Volume-Fader und 
alle Send Level-Fader gelb dargestellt. Beim 
Trimmen werden in der Lautstärkeanzeige oder 
Send-Pegelanzeige einer Spur nicht der absolute 
Wert, sondern der Deltawert angegeben.

Das Verhalten der Trim-Automationsmodi richtet 
sich auch nach der Einstellung der Coalesce Trim 
Automation-Voreinstellung. Siehe „Addieren der 
Trim-Automation“ auf Seite 1112. 

Wählen des Touch/Latch-Modus
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Trim Off

Im Trim Off-Modus wird das Lesen und Schreiben 
der gesamten Automation (Main und Trim) für 
eine Spur ausgeschaltet. Alle 
Automationsbewegungen für diese Spur werden 
während der Wiedergabe ignoriert. Trim-Fader 
werden vorübergehend auf Null gesetzt, wenn eine 
Spur in den Trim Off-Modus versetzt wird.

Je nach Einstellung der Coalesce Trim 
Automation-Voreinstellung kann beim Wechsel 
einer Spur in den Trim Off-Modus die Trim-
Automation mit dieser Spur addiert werden. Siehe 
„Addieren der Trim-Automation“ auf Seite 1112. 

Die Automation kann während der Wiedergabe 
oder Aufzeichnung vom Trim Off-Modus in einen 
anderen Automationsmodus geschaltet werden.

Read Trim

Im Read Trim-Modus werden die Trim-Fader für 
Lautstärke und Send-Pegel aus der Haupt-
Automations-Playlist ausgekoppelt und folgen der 
vorhandenen Trim-Automation. Sie können einen 
Trim-Fader während der Wiedergabe verschieben, 
um neue Trim-Werte abzuhören; es wird jedoch 
keine Automation aufgezeichnet. Wenn der Trim-
Fader losgelassen wird, kehrt er zu zuvor 
aufgezeichneten Trim-Automationswerten zurück.

Enthält eine Spur keine Trim-Automation, können 
Sie einen Trim-Fader während der Wiedergabe 
verschieben, um neue Trim-Werte abzuhören; 
es wird jedoch keine Automation aufgezeichnet. 
Der Trim-Fader behält seine Position bei, bis die 
Spur aus dem Trim-Modus entfernt wird oder Sie 
den Trim-Pegel manuell addieren.

Wenn dieser Modus aktiviert ist, verhalten sich 
nicht trimmbare Parameter (alle außer 
Spurlautstärke und Send-Pegel) wie im normalen 
Read-Modus: Es werden keine Automationsdaten 
aufgezeichnet.

Touch Trim

Im Touch Trim-Modus werden die Trim-Fader für 
Lautstärke und Send-Pegel aus der Haupt-
Automations-Playlist ausgekoppelt und folgen der 
vorhandenen Trim-Automation. Beim Berühren 
eines Trim-Faders beginnt die Aufzeichnung der 
Trim-Automation. Wenn der Fader losgelassen 
wird, hält die Aufzeichnung an und der Fader kehrt 
zu zuvor aufgezeichneten Trim-
Automationswerten zurück.

Der Zeitraum, den der Fader zur Rückkehr zu 
vorherigen Trim-Werten braucht, wird durch die 
AutoMatch Time-Einstellung auf der Automation-
Registerkarte bestimmt. Weitere Hinweise finden 
Sie unter „AutoMatch Time“ auf Seite 1080.

Wenn dieser Modus aktiviert ist, verhalten sich nicht 
trimmbare Bedienelemente (alle außer denjenigen für 
Spurlautstärke und Send-Pegel) wie im normalen 
Touch-Modus: Sie folgen der zuvor aufgezeichneten 
Automation, bis sie berührt werden. Wenn das 
geschieht, werden ihre absoluten Positionen 
aufgezeichnet, bis Sie die Regler loslassen oder die 
Wiedergabe gestoppt wird. 

Latch Trim

Im Latch-Modus werden die Trim-Fader für 
Lautstärke und Send-Pegel aus der Haupt-
Automations-Playlist ausgekoppelt und folgen der 
vorhandenen Trim-Automation. Beim Berühren 
eines Trim-Faders beginnt die Aufzeichnung der 
Trim-Automation. Die Aufzeichnung der Trim-
Automation geht weiter, bis die Wiedergabe anhält 
oder Sie aus der Automationsaufzeichnung 
aussteigen (Punch-Out). 

Wenn dieser Modus aktiviert ist, verhalten sich 
nicht trimmbare Parameter (alle außer 
Spurlautstärke und Send-Pegel) wie im normalen 
Latch-Modus: Sie folgen der zuvor 
aufgezeichneten Automation, bis sie berührt 
werden. Wenn dies geschieht, werden ihre 
absoluten Positionen aufgezeichnet, bis die 
Wiedergabe anhält.
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Touch/Latch Trim

Im Touch/Latch Trim-Modus werden die Trim-
Fader für Lautstärke und Send-Pegel aus der 
Haupt-Automations-Playlist ausgekoppelt und 
folgen der vorhandenen Trim-Automation. 
Der Main Volume Trim-Fader folgt dem Touch 
Trim-Verhalten und die Send Level Trim-Fader 
folgen dem Latch Trim-Verhalten. 

Write Trim

Wenn im Write Trim-Modus die Wiedergabe 
beginnt, fängt die Aufzeichnung der Trim-
Automation für die Lautstärke und Send-Pegel an; 
sie wird fortgesetzt, bis die Wiedergabe anhält oder 
Sie aus der Automationsaufzeichnung aussteigen 
(Punch-Out).

Wenn der Write Trim-Modus aktiviert ist, 
befinden sich nicht trimmbare Bedienelemente 
(alle außer denjenigen für Spurlautstärke und 
Send-Pegel) nicht im Write-Modus, sondern 
reagieren wie im normalen Touch-Modus (d. h., 
Automation wird erst aufgezeichnet, wenn ein 
Regler berührt wird). Dadurch wird verhindert, 
dass die Regler bei jedem Durchgang im Write 
Trim-Modus alle ihre Automationsdaten 
überschreiben.

Automation-Voreinstellungen
Pro Tools bietet Ihnen mehrere Möglichkeiten zur 
Steuerung der Aufzeichnung und Wiedergabe von 
Automationsdaten.

So zeigen Sie die Automation-Voreinstellungen an:

 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

Die Voreinstellung „After Write Pass, 
Switch To“ wirkt sich auf den Write/Trim-
Modus aus. Nach einem 
Automationsdurchgang im Write/Trim-
Modus wechseln die Spuren automatisch 
in die Version des Trim-Modus, die mit 
dieser Voreinstellung festgelegt wurde.

Mixing Preferences-Registerkarte, Automation

Ausführliche Informationen zu den 
Automation-Voreinstellungen in 
Pro Tools finden Sie unter „Mixing-
Voreinstellungen“ auf Seite 116.
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Send-Pegel und Trim-Modus
(Nur Pro Tools HD)

Sie können Pro Tools so einrichten, dass Send-
Pegel aus dem Trim-Modus ausgeschlossen 
werden, sodass nur der Main Volume-Regler in 
den Trim-Modus wechselt, wenn eine Spur in den 
Trim-Modus versetzt wird. Damit erhalten Sie 
mehr Flexibilität bei der Einstellung von Send-
Pegeln im Trim-Modus.

So schließen Sie Send-Pegel vom Trim-Modus aus:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Deaktivieren Sie unter „Automation“ die 
Include Sends in Trim Mode-Option.

3 Klicken Sie auf OK.

Smoothing
Wenn Sie Automationsbewegungen 
(einschließlich Trim-Bewegungen) mit einem 
Continuous Controller ausführen, zeichnet 
Pro Tools die Bewegung als Folge kleiner Schritte 
auf, was zu einer Art Treppenmuster mit vielen 
Breakpoints führt. Smoothing glättet dieses 
Treppenmuster und erzeugt einen einzigen, 
durchgehenden Verlauf zwischen zwei 
Breakpoints. (Smoothing ist für schaltbare 
Bedienelemente wie etwa Stummschaltung oder 
Plug-In-Bypass nicht verfügbar.) Wenn die 
Smoothing-Funktion aktiviert ist, spiegeln die 
resultierenden Automationsdaten die tatsächlichen 
Automationsbewegungen sehr genau wider. 

Thinning
Durch Thinning wird die Gesamtzahl von 
Breakpoints in einer Automations-Playlist 
(einschließlich Trim-Playlists) automatisch 
verringert, um die Leistung des Systems zu 
verbessern. Wie stark die Thinning-Funktion wirkt, 
d. h., wie viele irrelevante Automationsdaten 
entfernt werden, hängt von der Degree of Thinning-
Einstellung in den Automation-Voreinstellungen 
ab. Wenn Sie einen höheren Wert wählen, kann das 
Ergebnis eine Automation sein, die sich von den 
ursprünglichen Automationsbewegungen merklich 
unterscheidet. Thinning kann nur auf Audiospuren 
angewendet werden, MIDI-Spuren werden nicht 
beeinflusst. Hinweise dazu finden Sie unter 
„Thinning von Automation“ auf Seite 1099.

AutoMatch Time
Die AutoMatch Time-Einstellung gibt an, 
wie lange der Fader braucht, um am Ende des 
Automationsdurchgangs zum noch auf der Spur 
befindlichen Automationswert zurückzukehren 
(durch Hochfahren oder Herunterfahren). Dieser 
Wert wird in den Automation-Voreinstellungen 
festgelegt (siehe „Automation-Voreinstellungen“ 
auf Seite 1079).

AutoMatch wird automatisch auf alle Durchgänge im 
Touch-Modus angewendet und kann auf Latch- oder 
Write-Durchgänge angewendet werden.

Die AutoMatch Time-Einstellung bestimmt auch 
die Rate, mit der Deltawerte aufgezeichnet 
werden, wenn der Trim-Wert auf 0 dB (Deltawert 
gleich Null) zurückkehrt.

Die AutoMatch-Funktion funktioniert bei 
Continuous Controllern (etwa Lautstärke oder 
Panorama), indem ihre Werte auf zuvor 
automatisierte Pegel zurückgefahren werden. 
Es gibt einige gestufte Parameter (etwa den EQ-
Typ beim 1-Band-EQ-Plug-In), die mehr als zwei 
Betriebsstufen bieten. Auf diese Regler hat 
AutoMatch keine Auswirkung.

Jegliche nicht addierte Automation in einem 
Send wird dennoch addiert, wenn die andere 
Automation mit ihrer Spur addiert wird, und 
zwar selbst bei Deaktivierung von „Include 
Sends in Trim Mode“.
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Automation Follows Edit-Option
Ist dieser Befehl deaktiviert, wirken sich 
Bearbeitungen von Audio- oder MIDI-Noten nicht 
auf Automations-Events aus. Ist dieser Befehl 
aktiviert, wirken sich Bearbeitungen von Audio- 
oder MIDI-Noten auf Automations-Events aus.

Es gibt folgende Möglichkeiten, die Automation 
Follows Edit-Option in einer Session zu aktivieren 
oder zu deaktivieren:

 Aktivieren oder deaktivieren Sie Options > 

Automation Follows Edit.

 Klicken Sie auf die Automation Follows Edit-
Anzeige im Edit-Fenster Wenn aktiviert, wird 
die Anzeige hervorgehoben. Wenn nicht 
aktiviert, wird sie entsprechend nicht 
hervorgehoben.

AutomationSafe 
Ausgänge, Sends und Plug-Ins können durch den 
Automation Safe-Modus geschützt werden. 
Im Automation Safe-Modus sind alle Automationen, 
die mit einem Output-Fenster verknüpft sind 
(wie Spur- oder Send-Pegel, Panorama, 
Stummschaltung), und alle Plug-Ins auf dieser Spur 
vor dem Überschreiben geschützt, während andere 
Elemente dieser Spur automatisiert werden. 

Der Automation Safe-Modus verhindert die 
Automationsaufzeichnung für den selektierten 
Spurenausgang, Send oder das aktivierte Plug-In. 
Vom Automation-Fenster aus können Sie 
Automationsaufzeichnung und -wiedergabe auch für 
eine ganze Session aussetzen. Siehe „Aktivieren und 
Aussetzen von Automation“ auf Seite 1096. 

Darstellen von 
Automationsdaten
Pro Tools erstellt im Edit-Fenster eine separate 
Playlist für jeden Automationstyp in einer Spur, 
einschließlich einer Playlist für jede Art von Trim-
Automation. Diese Daten können genau wie 
Audio- und MIDI-Daten dargestellt und editiert 
werden. Sie können entweder Spurdarstellungen 
so ändern, dass die gewünschte Automation 
angezeigt wird, oder unabhängig von der 
Spurdarstellung eine Automations-Lane unter der 
Spur einblenden.

„Automation folgt Edit“-Anzeige im Edit-Fenster

Send mit aktiviertem Automation Safe-Modus

Sie können einfach zwischen verschiedenen 
Spurdarstellungen umschalten. Siehe 
„Ändern der Spurdarstellung“ auf Seite 229.
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Spurdarstellungen
Sie können Automationsdaten nach Typ anzeigen, 
indem Sie die entsprechende Spurdarstellung 
auswählen.

So zeigen Sie eine Automations-Playlist in der 
Spurdarstellung an:

 Klicken Sie auf den Track View-Selektor und 
wählen Sie den Automationstyp aus, den Sie 
anzeigen möchten.

Automations- und Controller-
Lanes
Im Edit-Fenster können Sie Automations- und 
Controllerdaten unter einer Spur anzeigen 
(unabhängig von der ausgewählten Spurdarstellung. 
Jede Spur enthält Automations- und Controller-
Lanes, mit denen Sie Automation- und 
Controllerdaten bearbeiten können, ohne die 
Spurdarstellung zu ändern. Sie können 
Automations- und Controllerdaten in Lanes auf 
dieselbe Weise bearbeiten wie in anderen 
Spurdarstellungen für Automation- und 
Controllerfunktionen.

Automations- und Controller-Lanes können 
angezeigt oder verborgen werden. Außerdem 
können Sie Lanes hinzufügen und entfernen. Diese 
Lanes bleiben immer unter der Spur, jedoch 
können Sie Lanes unabhängig voneinander in 
der Größe ändern oder neu anordnen.

So blenden Sie Automations-Lanes unter der 
Hauptspurdarstellung ein oder aus:

 Klicken Sie auf die Schaltfläche zum Ein-/ 
Ausblenden von Lanes.

So fügen Sie eine Lane hinzu:

 Klicken Sie auf die Schaltfläche zum 
Hinzufügen der Lane.

So entfernen Sie Lanes:

 Klicken Sie auf die Schaltfläche zum Entfernen 
der Lane.

Anzeigen einer standardmäßigen Automations-Playlist

Anzeigen von Trim-Automations-Playlists

Trim-Automations-Playlist

Einblenden einer Automations-Lane

Lanes-
Schaltfläche

ein-/aus-
blenden

Lane
entfernen

Lane
hinzufügen

Automation Type-Selektor
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So ändern Sie den Automations- oder 
Controllertyp für eine Lane:

 Klicken Sie auf den Automation/Controller 
Type-Selektor und wählen Sie den gewünschten 
Automations- oder Controllertyp aus.

So ersetzen Sie alle Automations- und Controller-
Lanes unter der Spur durch eine einzelne Lane des 
angegebenen Automations- oder Controllertyps:

1 Klicken Sie mit der rechten Maustaste auf die 
Schaltfläche zum Ein-/Ausblenden von Lanes.

2 Wählen Sie den gewünschten Automations- 
oder Controllertyp aus.

Zum Ändern der Höhe aller Automations- und 
Controller-Lanes für eine Spur führen Sie einen 
der folgenden Schritte aus:

 Klicken Sie mit der rechten Maustaste auf die 
vertikale Zoom-Skala rechts neben den Spur-
Steuerelementen und wählen Sie im Popup-
Menü die Höhe aus.

 Ziehen Sie die untere Linie einer bestimmten 
Lane Controls-Spalte nach oben oder unten. Die 
Cursor-Darstellung ändert sich und zeigt an, 
dass Sie die Größe der Lane verändern können.

So ändern Sie die Höhe einer einzelnen 
Automations- oder Controller-Lane für eine Spur:

 Halten Sie die Windows-Taste (Windows) bzw. 
Ctrl-Taste (Mac) gedrückt, während Sie die 
Lane Height-Einstellung auswählen.

So ordnen Sie Lanes neu an:

 Um Lanes auf dem Bildschirm neu anzuordnen, 
ziehen Sie den Lane-Steuerungsbereich im 
Edit-Fenster auf eine neue Position.

Auswählen des Automationstyps für eine Lane

Kontextmenü zur Auswahl einer einzelnen 
Automations- oder Controller-Lane

Halten Sie die Windows-Taste (Windows) 
bzw. Ctrl-Taste (Mac) gedrückt und 
verwenden Sie die Nach-oben- und Nach-
unten-Pfeiltasten, um die Höhe einer Lane, die 
den Edit-Cursor oder eine Edit-Selektion 
enthält, zu vergrößern oder zu verringern.
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Anzeigen der Trim-Automation 
zusammen mit der Haupt-Playlist
(Nur Pro Tools HD)

Die Darstellung der Trim-Automation richtet sich 
nach den Einstellungen für das Addieren. Siehe 
„Addieren der Trim-Automation“ auf Seite 1112. 

Wenn die Automation nicht so eingerichtet ist, 
dass sie nach jedem Automationsdurchgang 
addiert wird, können Sie Trim-Automationsdaten 
zusammen mit den Main Volume- oder Send 
Level-Automationsdaten in derselben 
Automation-Darstellung anzeigen. Diese Trim-
Automationsanzeige kann nicht direkt bearbeitet 
werden.

So zeigen Sie die Trim-Automations-Playlist 
zusammen mit der Haupt-Automations-Playlist auf 
Spuren an:

 Wählen Sie View > Automation > Trim Playlist.

Anzeigen der Composite-
Automations-Playlist
(Nur Pro Tools HD)

Wenn für die Automation keine Addietion nach 
jedem Automationsdurchgang eingerichtet ist, 
können Sie eine zusammengesetzte Automations-
Playlist anzeigen, die den Anteil der Trim-
Automation zu den Hauptlautstärke- oder Send-
Pegel-Automationsdaten zeigt. Diese Anzeige der 
zusammengesetzten Playlist kann nicht direkt 
bearbeitet werden.

Die zusammengesetzte Playlist wird sowohl in der 
Haupt-Automations-Playlist als auch in der Trim-
Automations-Playlist angezeigt.

So zeigen Sie die zusammengesetzte Playlist an: 

 Wählen Sie View > Automation > Composite 

Playlist. 

AutoMatch-Anzeigen
In jedem Kanalzug des Mix-Fensters befinden sich 
links unten dreieckige AutoMatch-Anzeigen. 
Leuchten sie, zeigt dies die Richtung an, in die sich 
der Fader beim Auto-Matching automatisch 
bewegen wird. 

Anzeige der Trim-Automation in einer Haupt-
Lautstärke-Playlist 

 
Volume 
Trim-
Daten

Volume-
Daten

Anzeige von Trim-Automation und der 
zusammengesetzten Playlist in einer Haupt-
Lautstärke-Playlist 

Dreieckige AutoMatch-Anzeige in einem Kanalzug

Volume Trim-Daten

Volume-Daten

Zusammen-
gesetzte 
Playlist
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Schreiben von 
Automationsdaten
Sie können Automationsdaten für alle 
automatisierbaren Steuerelemente schreiben, 
indem Sie diese während der Wiedergabe oder 
Aufnahme bewegen. 

So schreiben Sie Automationsdaten auf Spuren:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp für 
die Aufzeichnung aktiviert (write-enabled) ist.

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor jeder Spur, die Sie 
automatisieren möchten, und stellen Sie den 
Automationsmodus ein. Wählen Sie für den 
ersten Automationsdurchgang Write.

4 Starten Sie die Wiedergabe, um mit der 
Aufzeichnung der Automation zu beginnen.

5 Bewegen Sie die Bedienelemente, die Sie 
automatisieren möchten (beispielsweise einen 
Lautstärke-Fader der Spur).

6 Stoppen Sie nach Beendigung des Vorgangs die 
Wiedergabe.

Nach dem ersten Automationsdurchgang können 
Sie der Spur zusätzliche Automationsdaten 
hinzufügen, ohne den vorherigen Durchgang 
völlig zu löschen. Dazu müssen Sie den Touch- 
oder Latch-Modus wählen. In diesen beiden Modi 
werden nur dann neue Automationsdaten 
hinzugefügt, wenn Sie einen Regler des 
betreffenden Parameters verschieben. (Siehe 
„Automationsmodi“ auf Seite 1074.)

So fügen Sie einem Automationsdurchgang 
Daten hinzu:

1 Aktivieren Sie Options > Link Timeline and Edit 

Selection.

2 Nehmen Sie im Edit-Fenster eine Selektion vor 
oder positionieren Sie den Cursor an der Stelle, 
an der Sie Automationsdaten schreiben 
möchten.

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor jeder Spur, die Sie 
automatisieren möchten, und stellen Sie den 
Automationsmodus auf Touch- oder Latch-
Modus ein.

Wählen Sie die Enable Automation in 
Record-Option in den Opteration-
Einstellungen, um bei der Aufnahme 
Automationsdaten zu schreiben.

Automation-Fenster

Einstellen des Automationsmodus für eine Spur
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4 Starten Sie die Wiedergabe, um mit der 
Aufzeichnung der Automation zu beginnen. 

5 Bewegen Sie die Bedienelemente, die Sie 
automatisieren möchten.

6 Stoppen Sie nach Beendigung des Vorgangs die 
Wiedergabe.

Speichern einer anfänglichen 
Reglerposition
Wenn Sie eine neue Audio-, Auxiliary-Eingangs-, 
VCA Master-, MIDI- oder Instrumentenspur 
erzeugen, wird diese automatisch in den Read-
Modus versetzt. Obwohl sich die Spur im Read-
Modus befindet, können Sie die Anfangsposition 
jedes beliebigen automatisierbaren 
Bedienelements einstellen. Diese wird dann 
zusammen mit der Session gespeichert.

In diesem Anfangszustand erscheint nur ein 
einziger Automations-Breakpoint am Beginn 
jeder Automations-Playlist. Wenn Sie das 
Bedienelement bewegen, ohne Automation zu 
schreiben, wird der Breakpoint auf den neuen Wert 
verschoben.

Sie können die Anfangsposition eines 
automatisierbaren Bedienelements mit einer der 
folgenden Methoden dauerhaft speichern:

• Schalten Sie die Spur in den Write-Modus und 
drücken Sie auf „Play“, um für die Spur einige 
Sekunden Automationsdaten aufzuzeichnen.

• Setzen Sie manuell in der Automations-Playlist 
einen Breakpoint hinter dem Anfangs-
Breakpoint. (Weitere Informationen hierzu 
finden Sie unter „Grafisches Editieren von 
Automationsdaten“ auf Seite 1102.)

Automatisieren von Schalter-
Einstellungen
Wenn Schalter-Einstellungen (etwa 
Stummschaltungen, Plug-In-Bypasses oder 
Schalter-Einstellungen in Plug-Ins) automatisiert 
werden, behandelt Pro Tools diese wie 
berührungsempfindliche Bedienelemente. 
Automationsdaten werden so lange aufgezeichnet, 
wie die betreffende Taste bzw. die Schaltfläche des 
entsprechenden Bedienelements gedrückt oder 
berührt wird.

Wenn Sie etwa eine rasche Folge von 
Stummschaltungen auf einer Spur aufgezeichnet 
haben und diese Automation löschen möchten, 
müssten Sie manuell so vorgehen: Wählen Sie im 
Edit-Fenster die Automations-Playlist für „Mute“, 
wählen Sie die Automationsdaten der 
Stummschaltung und löschen Sie diese. 
In Pro Tools kann dies automatisch erfolgen.

So automatisieren Sie Schalter-Einstellungen (wie 
etwa die Stummschaltung):

1 Führen Sie einen weiteren 
Automationsdurchgang auf der Spur durch.

2 Wenn Sie an der Position des zu entfernenden 
Stummschaltungsstatus angekommen sind, 
halten Sie das schaltbare Bedienelement 
(etwa die Stummschaltung) gedrückt. 

3 Solange die Schaltfläche gedrückt bleibt, 
überschreibt Pro Tools die zugrunde liegenden 
Daten auf der Spur mit der aktuellen Schalter-
Einstellung (ein oder aus), bis Sie die 
Wiedergabe anhalten. 

Wenn Sie Automationsdaten im Touch-
Modus schreiben und die Loop Playback-
Option aktiviert haben, stoppt die 
Automationsaufzeichnung automatisch am 
Ende des Loop-Abschnitts. Am Anfang jedes 
folgenden Loops können Sie durch erneutes 
Berühren bzw. Bewegen des Bedienelements 
neue Daten aufzeichnen.

Wenn die Wiedergabe den ersten 
stummgeschalteten Abschnitt erreicht, 
erscheint die Mute-Taste markiert. 
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Automatisieren von Schalter-
Einstellungen im Touch-Modus
Wenn Schalter-Einstellungen (einschließlich 
Stummschaltungen, Plug-In-Bypasses oder 
Schalter-Einstellungen in Plug-Ins) im Touch-
Modus automatisiert werden, bleiben diese 
Bedienelemente auf eine Berührung hin im 
derzeitigen Zustand gesperrt.

Wenn man jedoch die Automation für diese 
Schalter-Einstellung später auf der Timeline 
beibehalten möchte, wird diese Sperrung der 
Einstellung aufgehoben, wenn eine der folgenden 
Situationen eintritt:

• Wenn ein vorhandener Automations-Breakpoint 
erreicht wird, beendet Pro Tools die 
Aufzeichnung der Automation an dieser Stelle.

• Wenn Sie die Wiedergabe anhalten oder aus der 
Automatisierungsaufzeichnung aussteigen 
(Punch-Out), bevor ein vorhandener 
Automations-Breakpoint erreicht wird, wendet 
Pro Tools die AutoMatch-Funktion auf den 
zugrunde liegenden Automationsstatus an.

Einstellen schaltbarer 
Bedienelemente für temporäre 
Funktionen
In manchen Fällen, beispielsweise beim 
Überschreiben oder Erweitern der Mute-
Automation, kann es sinnvoll sein, die Automation 
für ein Bedienelement temporär aufzuzeichnen, 
indem man dieses gedrückt hält, anstatt es 
einrasten zu lassen.

So stellen Sie schaltbare Bedienelemente für eine 
temporäre Funktion ein: 

1 Wählen Sie Options > Preferences und klicken 
Sie auf Mixing.

2 Deaktivieren Sie die Latching Behavior for 

Switch Controls in „Touch“ -Option.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

Automatisieren von Sends 
Pro Tools erlaubt die Automation von Send-Pegel, 
Send-Stummschaltung und Send-Panorama (nur 
bei Stereo- und Mehrkanal-Sends). Dadurch wird 
es möglich, die Pegel und die Platzierung von 
Effekten beim Mixdown mit großer Präzision zu 
regeln.

Send-Pegel und -Stummschaltung können so 
konfiguriert werden, dass sie sich nach Gruppen 
richten. 

So automatisieren Sie Pegel, Stummschaltung 
oder Panorama eines Sends:

1 Im Automation-Fenster muss der 
Automationstyp für die Aufzeichnung 
aktiviert sein (Send-Pegel, -Stummschaltung, 
-Panorama).

2 Stellen Sie im Mix- oder Edit-Fenster für jede 
Spur, die zu automatisierende Sends enthält, 
den Automationsmodus ein. Klicken Sie für 
jede Spur auf den Automation Mode-Selektor 
und wählen Sie einen Automationsmodus. 
Wählen Sie für den ersten 
Automationsdurchgang „Write“.

3 Wenn keine Sends auf den Spuren sichtbar sind, 
wählen Sie View > Mix Window (oder Edit 

Window) und Sends A–E (oder Sends F–J).

4 Zum Anzeigen von Send-Bedienelementen 
haben Sie folgende Möglichkeiten:

• Klicken Sie auf den Send, um das Output-
Fenster für den zu automatisierenden Send zu 
öffnen.

• Wählen Sie View > Sends A–E (oder Sends F–J) 
und eine der individuellen Send-Ansichten 
(etwa Send A).
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5 Starten Sie die Wiedergabe, um mit der 
Aufzeichnung der Automation zu beginnen. 

6 Bewegen Sie die Bedienelemente, die Sie 
automatisieren möchten.

7 Stoppen Sie nach Beendigung des Vorgangs die 
Wiedergabe. 

Send-Pegel, Stummschaltung und Panorama 
können auch so konfiguriert werden, dass sie sich 
nach Mix-Gruppen richten (siehe „Automation-
Voreinstellungen“ auf Seite 1079). 

Kopieren von Spurautomation 
auf Sends
(Nur Pro Tools HD)

In einigen Situationen ist es vielleicht 
wünschenswert, dass die Send-Einstellungen oder 
-Automation einer Spur den Einstellungen oder 
der Automation innerhalb der Spur entspricht, 
etwa wenn Sie eine Kopfhörermischung auf Basis 
der Hauptmischung erstellen oder ein Effektpegel 
den Pegeln in einer Hauptmischung folgen soll. 
Sie können die aktuellen Einstellungen oder die 
gesamte Automations-Playlist für die 
ausgewählten Bedienelemente in die 
entsprechende Playlist des Sends kopieren.

So kopieren Sie die Einstellungen oder 
Automation einer Spur auf einen ihrer Sends:

1 Wählen Sie die zu editierenden Spuren aus, 
indem Sie auf die Spurnamen klicken.

2 Wählen Sie Edit > Automation > Copy To Send.

3 Führen Sie im Copy to Send-Dialogfeld einen 
der folgenden Schritte aus: 

• Wählen Sie Current Value, um die aktuellen 
Einstellungen der entsprechenden Parameter zu 
kopieren. 

• Wählen Sie Automation, um die gesamte 
Automations-Playlist für die entsprechenden 
Parameter zu kopieren.

4 Wählen Sie die Parameter, die Sie kopieren 
möchten. 

5 Wählen Sie die Sends aus, auf die die 
Automationsdaten kopiert werden sollen, und 
klicken Sie auf OK.

Sie können die Ergebnisse des Copy to Send-
Befehls rückgängig machen.

Copy To Send-Dialogfeld



Kapitel 45: Automation 1089

Automatisieren von Plug-Ins 
Sie können Änderungen an nahezu allen Plug-In-
Steuerelementen automatisieren. Das 
Automatisieren eines Plug-Ins unterscheidet sich 
ein wenig von anderen Automationsvorgängen, 
da Sie dazu einzelne Plug-In-Steuerelemente 
aktivieren müssen. 

So aktivieren Sie Plug-In-Steuerelemente für 
die Automation: 

1 Öffnen Sie das Plug-In-Fenster für das Plug-In, 
das Sie automatisieren möchten.

2 Sie haben folgende Möglichkeiten:

• Klicken Sie im Plug-In-Fenster auf die 
Schaltfläche zum Aktivieren der Automation.

• Halten Sie die Strg-, Alt- und Windows-Taste 
(Windows) bzw. die Befehls-, Wahl- und Ctrl-
Taste (Mac) gedrückt und klicken Sie im Edit-
Fenster auf den Track View-Selektor.

3 Wählen Sie im Plug-In Automation-Dialogfeld 
die Steuerelemente aus, die Sie automatisieren 
möchten, und klicken Sie auf Add. Wenn sich 
auf derselben Spur mehrere Plug-Ins befinden, 
können Sie unter ihnen auswählen, indem Sie in 
diesem Dialogfeld im Inserts-Bereich auf die 
entsprechenden Schaltflächen klicken. 

4 Klicken Sie auf OK, um das Plug-In 
Automation-Dialogfeld zu schließen.

So automatisieren Sie ein Plug-In:

1 Im Plug-In Automation Enable-Fenster muss 
die Plug-In-Automation für die Steuerelemente, 
die Sie automatisieren möchten, aktiviert sein.

2 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor der Spur mit den 
Plug-Ins, die Sie automatisieren möchten, und 
stellen Sie den Automationsmodus ein. Wählen 
Sie für den ersten Automationsdurchgang 
Write.

3 Starten Sie die Wiedergabe, um mit der 
Aufzeichnung der Automation zu beginnen, 
und bewegen Sie die zu automatisierenden 
Steuerelemente.

4 Stoppen Sie nach Beendigung des Vorgangs die 
Wiedergabe.

Automation Enable-Schaltfläche für den Zugriff auf 
das Plug-In Automation-Dialogfeld

Plug-In Automation-Dialogfeld
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Aktivieren der Automation für 
einzelne Plug-In-Parameter
Sie können einzelne Plug-In-Steuerelemente 
direkt vom Plug-In-Fenster aus aktivieren.

So aktivieren Sie einen Plug-In-Parameter vom 
Plug-In-Fenster:

1 Vergewissern Sie sich, dass das zu 
automatisierende Plug-In im Plug-In-Fenster 
angezeigt wird. 

2 Halten Sie die Befehls-, Wahl- und Ctrl-Taste 
(Mac) bzw. die Strg-, Alt- und Windows-Taste 
(Windows) gedrückt und klicken Sie auf das 
Steuerelement für den Parameter.

Aktivieren der Automation für 
alle Plug-In-Parameter

So aktivieren Sie alle Plug-In-Parameter:

1 Vergewissern Sie sich, dass das zu 
automatisierende Plug-In im Plug-In-Fenster 
angezeigt wird. 

2 Klicken Sie bei gedrückter Befehls-, Wahl- und 
Ctrl-Taste (Mac) bzw. Strg-, Alt- und Windows-
Taste (Windows) auf die Auto-Schaltfläche 
oben im Plug-In-Fenster. 

Automatisches Aktivieren von 
Plug-Ins zur Automation
Sie können Pro Tools so einrichten, dass 
automatisch alle Steuerelemente eines Plug-Ins zur 
Automation aktiviert werden, wenn Sie das Plug-In 
zum ersten Mal Ihrer Session hinzufügen. 

So aktivieren Sie automatisch alle Plug-In-
Parameter für die Automation:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Wählen Sie Plug-In Controls Default to Auto-
Enabled.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

Farbkennzeichnung des 
Automationsmodus für Plug-In-
Parameter
Im Plug-In-Fenster sind die Steuerelemente für 
Plug-In-Parameter in unterschiedlichen Farben 
hervorgehoben und geben an, ob und in welchem 
Modus sie jeweils automatisiert sind. Die 
unterschiedlichen Farben weisen auch darauf hin, 
ob ein Parameter von einer Bedienoberfläche 
(beispielsweise D-Command oder Command|8) 
gesteuert wird oder nicht. 

In der folgenden Tabelle sehen Sie die 
Farbkodierung für automatisierte Plug-In-
Parameter mit und ohne Bedienoberfläche.

Aktivieren der Plug-In-Automation für einzelnen 
Parameter

Farbkodierung für automatisierte Plug-In-Parameter

Automati-
onsmodus:

Off Read
Touch, 
Latch, 
Write

Keine 
Bedien- 
oberfläche

keine Grün Rot

Control-
Port (für 
Bedienober-
fläche)

keine Blau Gelb
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Sichern der Plug-In-Automation
Mit dem Automation Safe-Modus können Sie 
verhindern, dass Automationsdaten überschrieben 
werden.

So aktivieren Sie den Safe-Modus für ein Plug-In:

1 Öffnen Sie ein Plug-In. 

2 Klicken Sie auf die Safe-Schaltfläche, 
die daraufhin hervorgehoben wird.

Automatisches Anpassen von 
Steuerelementen
(Nur Pro Tools HD)

Mit der AutoMatch-Schaltfläche im Automation-
Fenster können Sie Automations-Steuerelemente 
automatisch auf ihren bestehenden 
Automationspegel anpassen.

Automatisches Anpassen aller 
Steuerelemente
Sie können alle derzeit aufzeichnenden Parameter 
mit AutoMatch auf ihren bestehenden 
Automationspegel anpassen.

So passen Sie alle derzeit aufzeichnenden 
Parameter mit AutoMatch an:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass die Automationstypen, 
die Sie mit AutoMatch anpassen möchten, 
für die Aufzeichnung aktiviert (write-enabled) 
sind.

3 Starten Sie die Wiedergabe. 

4 Wenn Sie auf der Spur eine Stelle erreichen, an 
der Sie die Parameter auf ihre zuvor 
aufgezeichneten Werte zurücksetzen möchten, 
klicken Sie im Automation-Fenster auf die 
AutoMatch-Schaltfläche.

Alle derzeit aufzeichnenden Parameter beenden 
die Automationsaufzeichnung und kehren gemäß 
der AutoMatch Time-Einstellung in den Mixing-
Voreinstellungen zu zuvor aufgezeichneten 
Werten zurück.

Automatisches Anpassen 
einzelner Spuren
Sie können die AutoMatch-Funktion auf einzelnen 
Spuren ausführen. Alle derzeit aufzeichnenden 
Parameter auf der Spur beenden die Aufzeichnung 
und kehren zu bestehenden Automationspegeln 
zurück.

So passen Sie alle Parameter auf einer Spur mit 
AutoMatch an:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf den 
Automation Mode-Selektor auf der Spur.

„Automation Safe“ für Plug-In aktiviert

AutoMatch-Schaltfläche im Automation-Fenster
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Automatisches Anpassen 
einzelner Automationstypen
Sie können die AutoMatch-Funktion für einzelne 
Automationstypen in einer Session aktivieren. 

So passen Sie alle Parameter eines 
Automationstyps mit AutoMatch an:

 Klicken Sie im Automation-Fenster mit 
gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf die Schaltfläche für den 
Automationstyp (Volume, Pan, Mute, Plug-In, 
Send Level, Send Pan oder Send Mute). 

Automatisches Anpassen 
einzelner Parameter
(Nur D-Control und D-Command)

Auf ICON-Bedienoberflächen können Sie die 
AutoMatch-Funktion für einzelne Bedienelemente 
oder Bedienelementtypen in einzelnen Kanälen 
ausführen.

So passen Sie alle Bedienelemente eines Typs in 
einem Kanal mit AutoMatch an:

 Halten Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und drücken Sie 
eines der folgenden Channel Strip Mode-
Bedienelemente für die Spur, deren 
Bedienelemente Sie mit AutoMatch anpassen 
möchten:

• Inserts

• Sends

• Pan

• Dyn (nur D-Control)

• EQ (nur D-Control)

So passen Sie ein Panorama-Bedienelement oder 
die Bedienelemente für ein einzelnes Insert oder 
Send mit AutoMatch an:

1 Drücken Sie den Schalter innerhalb der Channel 
Strip Mode-Bedienelemente, um die Pan-
Bedienelemente oder die obere Ebene der 
Inserts oder Sends für den Kanal anzuzeigen. 

2 Halten Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und drücken Sie 
den Rotary Encoder Select-Schalter für das 
Bedienelement, das Sie mit AutoMatch 
anpassen möchten:

• Für Sends werden die Bedienelemente für Send-
Pegel, -Panorama und -Stummschaltung 
automatisch angepasst. 

• Bei Inserts werden alle automatisierten 
Bedienelemente automatisch angepasst. 

• Für Pan werden alle Pan-Schieberegler im Kanal 
automatisch angepasst. 

So passen Sie alle Bedienelemente für ein im 
Dynamics- oder EQ-Bereich angezeigtes Plug-In 
mit AutoMatch an:

 Halten Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und drücken Sie 
im Dyn- oder EQ-Bereich des Mischpults den 
Auto-Schalter. 
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Vorbereiten von 
Bedienelementen für die 
Automationsaufzeichnung im 
Latch-Modus
(Nur Pro Tools HD)

Wenn eine Spur sich im Latch- oder Touch/Latch-
Automationsmodus befindet, können Sie einzelne 
Bedienelemente für die Automationsaufzeichnung 
vorbereiten, während der Transport angehalten ist. 
Diese Latch Prime-Funktion ermöglicht Ihnen die 
Vorbereitung eines Automationsdurchgangs vor 
dem Beginn der Wiedergabe.

So bereiten Sie Bedienelemente für die 
Automationsaufzeichnung im Latch-Modus vor, 
während der Transport angehalten ist:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Wählen Sie unter „Automation“ die Allow Latch 

Prime in Stop-Option.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

4 Im Automation-Fenster müssen die 
Bedienelemente, die Sie automatisieren 
möchten, für die Aufzeichnung aktiviert sein 
(write-enabled).

5 Klicken Sie auf der Spur, für die Sie die 
Automationsaufzeichnung durchführen 
möchten, auf den Automation Mode-Selektor 
und führen Sie einen der folgenden Schritte aus:

• Wählen Sie den Latch-Modus, um die 
Vorbereitung aller automatisierten 
Bedienelemente auf der Spur zu ermöglichen.

• Wählen Sie den Touch/Latch-Modus, um den 
Main Volume-Fader im Touch-Modus zu 
belassen und die Vorbereitung aller anderen 
automatisierten Bedienelemente zu 
ermöglichen.

6 Während der Transport angehalten ist, berühren 
oder bewegen Sie die Bedienelemente, die zu 
Beginn des Automationsdurchgangs mit der 
Aufzeichnung starten sollen. Wenn mindestens 
ein Bedienelement auf einer Spur vorbereitet ist, 
wird der Automation Mode-Selektor rot 
dargestellt.

7 Starten Sie die Wiedergabe. Alle vorbereiteten 
Bedienelemente beginnen bei ihren 
vorbereiteten Werten mit der 
Automationsaufzeichnung.

8 Halten Sie die Wiedergabe an, um den 
Automationsdurchgang zu beenden. Für alle 
Spuren wird der Latch Prime-Status 
aufgehoben.

Automationsmodus-Anzeige vor (links) und nach 
(rechts) dem Vorbereiten von Bedienelementen im 
Latch-Modus

Sie können am Ende des Automationsdurchgangs 
den Write to Punch-Befehl verwenden, um den 
aktuellen Wert zum Start des Durchgangs 
zurückzuschreiben. 
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Aufheben des Latch Prime-
Status für Spuren und 
Bedienelemente
Sie können den Latch Prime-Status für einzelne 
Spuren oder Automationstypen vor oder während 
eines Automationsdurchgangs aufheben. 

 Wenn Sie den Latch Prime-Status für eine Spur 
oder einen Automationstyp aufheben, bevor Sie 
die Wiedergabe starten, bleibt sie bzw. er im Latch-
Modus, aber die entsprechenden Bedienelementen 
werden nicht zum Aufzeichnen vorbereitet, wenn 
die Wiedergabe beginnt.

 Wenn Sie den Latch Prime-Status während eines 
Automationsdurchgangs für eine Spur oder einen 
Automationstyp aufheben, werden die 
entsprechenden Bedienelemente mit AutoMatch 
auf ihre derzeit aufgezeichneten Werte angepasst.

 Wenn Sie ein Bedienelement, das sich im Latch 
Prime-Status befindet, mit AutoMatch anpassen, 
wird dieses nicht mehr vorbereitet. 

So heben Sie den Latch Prime-Status für eine 
Spur auf:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf den 
Automation Mode-Selektor auf der Spur. 

Die Selektor-Schaltfläche wird nicht mehr fett 
dargestellt, um anzugeben, dass die Spur nicht 
mehr vorbereitet wird.

Führen Sie einen der folgenden Schritte aus, 
um den Latch Prime-Status für alle Spuren 
aufzuheben:

 Klicken Sie bei gedrückter Alt- und Strg-Taste 
(Windows) bzw. Wahl- und Befehlstaste (Mac) 
auf den Automation Mode-Selektor auf einer 
Spur. 

 Klicken Sie auf die AutoMatch-Schaltfläche im 
Automation-Fenster. 

Führen Sie einen der folgenden Schritte aus, 
um den Latch Prime-Status für alle ausgewählten 
Spuren aufzuheben:

 Klicken Sie bei gedrückter Alt-, Strg- und 
Umschalttaste (Windows) bzw. Wahl-, Befehls- 
und Umschalttaste (Mac) auf den Automation 
Mode-Selektor auf einer Spur. 

 Klicken Sie bei gedrückter Alt- und 
Umschalttaste (Windows) bzw. Wahl- und 
Umschalttaste (Mac) auf die AutoMatch-
Schaltfläche im Automation-Fenster. 

AutoMatch-Schaltfläche im Automation-Fenster
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Führen Sie einen der folgenden Schritte aus, um den 
Latch Prime-Status für einen Automationstyp auf 
allen Spuren aufzuheben:

 Klicken Sie im Automation-Fenster mit 
gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf die Schaltfläche für den 
Automationstyp (Volume, Pan, Mute, Plug-In, 
Send Level, Send Pan oder Send Mute). 

Rollen durch Automation Punch-
Punkte im Latch Prime-Status
Nachdem Sie bei angehaltenem Transport 
Bedienelemente für die 
Automatisierungsaufzeichnung vorbereitet haben, 
können Sie Pro Tools so einrichten, dass nach 
Ausgabe eines Back and Play-Befehls oder nach 
dem Zurückrollen und Einlocken auf den 
Timecode automatisch an dieser Stelle ein Punch 
ausgeführt wird.

So richten Sie Pro Tools ein, für die 
Automationsaufzeichnung auf einer Spur 
automatisch einen Punch auszuführen:

1 Platzieren Sie den Cursor an der Stelle, an der 
Sie für die Automation einen Punch ausführen 
möchten. 

2 Bereiten Sie Bedienelemente zum Aufzeichnen 
vor, während der Transport angehalten ist. 
(Siehe „Vorbereiten von Bedienelementen für 
die Automationsaufzeichnung im Latch-
Modus“ auf Seite 1093.)

3 Klicken Sie im Automation-Fenster auf die 
AutoJoin-Schaltfläche.

4 Klicken Sie im Automation-Fenster auf die 
Capture-Schaltfläche und dann auf die Punch 
Capture-Schaltfläche. Der AutoJoin-Marker 
(eine vertikale rote Linie) wird nach dem 
Punch-Punkt am Bildschirm angezeigt.

5 Geben Sie einen Back and Play-Befehl aus, 
lassen Sie das externe Gerät an eine Stelle vor 
dem Punch In-Punkt zurücklaufen oder 
aktivieren Sie die Pre-Roll-Funktion.

6 Starten Sie die Wiedergabe. Wenn der Transport 
den Punch-In-Punkt erreicht, beginnt die 
Automatisierungsaufzeichnung.

Automationstyp-Schaltflächen im Automation-Fenster

Capture-Schaltfläche im Automation-Fenster

Punch Capture-Schaltfläche im Automation-Fenster
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Aktivieren und Aussetzen 
von Automation
Vom Automation-Fenster aus können Sie die 
Aufzeichnung für folgende Automationstypen in 
allen Spuren aktivieren oder aussetzen:

• Volume

• Volume Trim

• Pan

• Stummschaltung

• Plug-In

• Send Level

• Send Level Trim

• Send Pan

• Send Mute

Die Automation kann während der Wiedergabe 
ausgesetzt oder aktiviert werden (ohne den 
Transport anhalten zu müssen).

Aussetzen der Automation auf 
allen Spuren

So setzen Sie die Automation auf allen Spuren aus:

1 Wählen Sie Window > Automation. 

2 Sie haben folgende Möglichkeiten:

• Um die gesamte Automation auf allen Spuren 
auszusetzen, klicken Sie auf die Suspend-
Schaltfläche.

• Um die Aufzeichnung eines bestimmten 
Automationstyps auf allen Spuren auszusetzen, 
klicken Sie auf die Schaltfläche für diesen Typ 
(„Volume“, „Mute“, „Pan“, „Plug-In“, „Send 
Level“, „Send Mute“ oder „Send Pan“).

So setzen Sie die Trim-Automation auf allen 
Spuren aus (nur Pro Tools HD):

 Klicken Sie im Automation-Fenster bei 
gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf die Suspend-
Schaltfläche. 

Die Suspend-Schaltfläche wird gelb 
hervorgehoben, um anzugeben, dass die Trim-
Automation ausgesetzt ist. 

Aussetzen der Automation für 
einzelne Parameter
Sie können die Automation für ein oder mehrere 
Bedienelemente aussetzen. Wenn ein Parameter 
ausgesetzt ist, wird sein Name im Track View-
Selektor kursiv dargestellt.

Suspend-Schaltfläche im Automation-Fenster

Die Aussetzung der Automation vom Edit-
Fenster aus richtet sich nach Edit-Gruppen. 
Zum Unterdrücken des Gruppenverhaltens 
halten Sie die Windows- (Windows) bzw. 
Befehlstaste (Mac) gedrückt, während Sie 
einen Parameter aussetzen.



Kapitel 45: Automation 1097

So setzen Sie die Automation für einzelne 
Parameter auf einer Spur aus:

1 Stellen Sie im Edit-Fenster den Track View-
Selektor so ein, dass die Automations-Playlist für 
den gewünschten Parameter angezeigt wird.

2 Sie haben folgende Möglichkeiten:

• Um lediglich die Aufzeichnung und Wiedergabe 
der Automation für den angezeigten Parameter 
auszusetzen, klicken Sie bei gedrückter Strg-
Taste (Windows) bzw. Befehlstaste (Mac) auf 
den Namen des Parameters im Track View-
Selektor. 

• Um die Aufzeichnung und Wiedergabe der 
Automation für alle Parameter auszusetzen, 
klicken Sie bei gedrückter Strg- und 
Umschalttaste (Windows) bzw. Befehls- und 
Umschalttaste (Mac) auf den Namen eines 
beliebigen Parameters im Track View-Selektor.

• Um die Aufzeichnung und Wiedergabe der 
Automation für einen bestimmten Parameter auf 
allen Spuren auszusetzen, klicken Sie bei 
gedrückter Strg- und Alt-Taste (Windows) bzw. 
Befehls- und Wahltaste (Mac) auf den Namen des 
Parameters im Track View-Selektor.

So setzen Sie die Trim-Automation für einzelne 
Bedienelemente auf einer Spur aus (nur 
Pro Tools HD):

1 Stellen Sie im Edit-Fenster den Track View-
Selektor so ein, dass die Automations-Playlist 
für den Trim-Parameter angezeigt wird, den Sie 
aussetzen möchten („Volume Trim“ oder „Send 
Level Trim“). 

2 Sie haben folgende Möglichkeiten:

• Um nur den angezeigten Trim-Parameter auf 
einer einzelnen Spur auszusetzen, klicken Sie 
bei gedrückter Strg-Taste (Windows) bzw. 
Befehlstaste (Mac) auf den Namen des 
Parameters im Track View-Selektor.

• Um den angezeigten Trim-Parameter auf allen 
Spuren auszusetzen, klicken Sie bei gedrückter 
Strg- und Alt-Taste (Windows) bzw. Befehls- und 
Wahltaste (Mac) auf den Namen des Parameters 
im Track View-Selektor.

Anzeigen des Automation 
Enable-Status

Track Automation Mode-Selektoren

 Wenn eine Spur für die Automation aktiviert ist, 
jedoch keine Automation aufzeichnet, wird der 
Modus am Automation Mode-Selektor als 
normaler roter Text angezeigt. 

 Zeichnet ein Bedienelement auf einer Spur 
gerade Automation auf, wird der Modus am 
Automation Mode-Selektor als hervorgehobener 
roter Text angezeigt.

Schaltflächen im Automation-Fenster

 Wenn ein Automationstyp die Automation auf 
einer Spur in der Session aufzeichnet, wird die 
entsprechende Schaltfläche im Automation-
Fenster als fetter roter Text angezeigt. 

 Wenn ein Automationstyp aktiviert ist, jedoch 
keine Automation in der Session aufzeichnet, wird 
die entsprechende Schaltfläche im Automation-
Fenster als normaler roter Text angezeigt. 

Automation Mode-Selektor mit aktiviertem Status 
(links) und Aufzeichnungsstatus (rechts)

Automation-Fenster mit möglichen 
Automationszuständen

Aktiviert

Nicht aktiviert
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Richtlinien zur 
Automationsaktivierung
Die folgenden Regeln bestimmen, ob Automation 
für eine Spur aktiviert ist:

 Obwohl Pro Tools für jede Spur nur einen 
einzigen Automationsmodus anzeigt, befinden 
sich nicht unbedingt alle automatisierbaren 
Parameter einer Spur in demselben 
Automationsmodus.

 Wenn im Automation-Fenster die Automation 
global ausgesetzt wird, reagieren alle 
automatisierbaren Parameter so wie im Off-
Modus, unabhängig vom aktuellen 
Automationsmodus der Spur.

 Wenn Sie die Automation für einen Parameter 
aussetzen, indem Sie im Track View-Selektor bei 
gedrückter Strg- (Windows) bzw. Befehlstaste 
(Mac) auf seinen Namen klicken, verhält sich 
dieser wie im Off-Modus, unabhängig vom 
aktuellen Automationsmodus der Spur.

 Wenn die Automation eines Steuerelements im 
Automation-Fenster ausgesetzt wird, verhält sich 
dieser wie im Read-Modus, wenn die Spur sich in 
einem Schreib-Automationsmodus befindet 
(„Touch“, „Latch“ oder „Write“).

Löschen von 
Automationsdaten
Die Automationsdaten werden als 
Liniendiagramm mit editierbaren Breakpoints 
dargestellt. Die einfachste Form, 
Automationsdaten aus einer Spur oder einer 
Selektion zu entfernen, ist das manuelle Löschen 
von Breakpoints aus der Automations-Playlist.

Diese Methode der Datenentfernung unterscheidet 
sich vom Cut-Befehl, welcher an den Grenzen der 
verbleibenden Daten Anker-Breakpoints erzeugt. 
Ausführliche Informationen hierzu finden Sie unter 
„Ausschneiden, Kopieren und Einfügen von 
Automationsdaten“ auf Seite 1106. 

Zum Entfernen von Automationsdaten zeigen Sie 
die zu editierende Automations-Playlist an, indem 
Sie sie im Track View-Selektor auswählen oder 
auf einer Automations-Lane einblenden, und 
führen Sie einen der folgenden Schritte aus:

So entfernen Sie einen einzelnen Breakpoint:

 Klicken Sie mit dem Pencil- oder einem 
beliebigen Grabber-Tool bei gedrückter Wahl- 
(Mac) bzw. Alt-Taste (Windows) auf 
den Breakpoint.

So entfernen Sie mehrere Breakpoints gleichzeitig:

 Markieren Sie mit dem Selector-Tool 
den Bereich, der die Breakpoints enthält, 
und drücken Sie die Entf-Taste (Mac) bzw. die 
Rücktaste (Windows).

So entfernen Sie sämtliche Automationsdaten des 
angezeigten Typs:

 Klicken Sie mit dem Selector-Tool in die Spur 
und wählen Sie Edit > Select All. Drücken Sie 
anschließend die Entf-Taste (Mac) bzw. die 
Rücktaste (Windows).

So entfernen Sie die gesamte Automation für alle 
Automations-Playlists einer Spur:

1 Wählen Sie mit Hilfe des Selector-Tools den 
Bereich, aus dem die Daten entfernt werden 
sollen.

2 Drücken Sie die Ctrl- und Entf-Taste (Mac) 
bzw. die Windows- und Rücktaste (Windows).

Alle Automationsdaten der Selektion werden für 
alle Automations-Playlists in dieser Spur entfernt, 
unabhängig davon, ob die Bedienelemente für 
diese Aufzeichnung von Automation aktiviert sind 
oder nicht.
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Löschen der Trim-Automation
(Nur Pro Tools HD)

Wenn die Trim-Automation nicht mit einer Spur 
addiert wurde, können Sie sie löschen. Beim 
Löschen der Trim-Automation werden 
Automation-Breakpoints auf allen Trim-Playlists 
gelöscht und alle Trim-Fader auf Null 
zurückgesetzt.

So löschen Sie die Trim-Automation:

1 Wählen Sie die Spur, auf der Sie die Trim-
Automation löschen möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Clear Trim Automation.

• Klicken Sie mit der rechten Maustaste auf 
den Spurnamen und wählen Sie Clear Trim 

Automation.

Thinning von Automation
Pro Tools zeichnet während eines 
Automationsdurchgangs Automationsdaten in 
Form von Breakpoints mit maximaler Dichte auf. 
Da Pro Tools Verläufe zwischen Breakpoints 
erzeugt, brauchen Sie vielleicht nicht alle erfassten 
Breakpoints, um eine klanggenaue Darstellung 
Ihrer Automationsbewegungen zu erreichen. Jeder 
Breakpoint beansprucht einen Teil des der 
Automation zugewiesenen Speicherplatzes. Das 
Entfernen nicht benötigter Breakpoint-Daten 
(Thinning) kann also zu größerer Effizienz und 
Leistung führen.

In Pro Tools gibt es zwei Möglichkeiten, 
irrelevante Automationsdaten zu löschen: 
automatisch mit der Smooth and Thin Data After 

Pass-Option und manuell mit den Thin 

Automation-Befehlen.

Smooth and Thin Data After Pass
Wenn diese Option auf der Mixing Preferences-
Registerkarte ausgewählt wurde, entfernt Pro Tools 
automatisch nach jedem Automationsdurchgang 
unnötige Automations-Breakpoints.

In den Standardeinstellungen für neue Sessions ist 
die Smooth and Thin Data After Pass-Option 
ausgewählt und die Degree of Thinning-
Einstellung auf Some gesetzt. In den meisten 
Fällen führt diese Einstellung zu optimaler 
Leistung und zur exakten Wiedergabe Ihrer 
Automationsbewegungen.

Wenn Sie None für die Degree of Thinning-
Einstellung auswählen, zeichnet Pro Tools die 
größtmögliche Anzahl an Breakpoints auf. 
Trotzdem können Sie mit Hilfe des Thin 

Automation-Befehls jederzeit irrelevante Daten 
entfernen. Weitere Informationen für das 
Smoothing von Automationsdaten finden Sie unter 
„Smoothing“ auf Seite 1080.
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Thin Automation-Befehle
Mit den Befehlen Thin Automation und Thin All 

Automation können Sie selektiv Bereiche 
entfernen, in denen die Dichte von 
Automationsdaten zu hoch ist. Mit Hilfe des 
Undo-Befehls können Sie das Ergebnis des 
Thinning-Vorgangs abhören (zum Vergleich 
vor und nach dem Thinning), bevor Sie die Daten 
endgültig entfernen.

So entfernen Sie Automationsdaten manuell:

1 Klicken Sie im Edit-Fenster auf den Track 
View-Selektor, um den Automationstyp 
anzuzeigen, auf den das Thinning angewendet 
werden soll, oder blenden Sie die entsprechende 
Automations-Lane ein.

2 Markieren Sie mit dem Selector-Tool die für das 
Thinning vorgesehenen Automationsdaten. Um 
das Thinning auf die Automation der gesamten 
Spur anzuwenden, klicken Sie mit dem 
Selector-Tool in die Spur und wählen Sie Edit > 

Select All.

3 Sie haben folgende Möglichkeiten:

• Um das Thinning nur auf den derzeit 
angezeigten Automationstyp anzuwenden, 
wählen Sie Edit > Automation > Thin.

• Um das Thinning auf alle Automationstypen 
anzuwenden, wählen Sie Edit > Automation > 

Thin All.

Zeichnen von 
Automationsdaten
Sie können mit Hilfe des Pencil-Tools 
Automationsdaten für Audio- und MIDI-Spuren 
erzeugen, indem Sie sie direkt in eine beliebige 
Automations- oder MIDI-Controller-Playlist 
zeichnen; das betrifft auch die Trim-Automation, 
wenn sie noch nicht addiert wurde.

Mit dem Pencil-Tool können Automationsdaten in 
folgenden Verlaufsformen gezeichnet werden:

Free Hand. – erstellt anhand der Mausbewegungen 
eine Freihandzeichnung. Bei Audiospuren enthält 
die Form die Anzahl von Breakpoints, die zum 
nahtlosen Interpolieren und Wiedergeben der 
Automationsform nötig sind. Bei MIDI-Spuren 
wird die Form als Stufenreihe wiedergegeben, 
entsprechend der Auflösungseinstellung auf der 
MIDI Preferences-Registerkarte.

Zeile. – zeichnet eine gerade Linie. In Audiospuren 
verfügt die Linie an beiden Enden über je einen 
Breakpoint. In MIDI-Spuren ändert sich der 
Controller-Wert stufenweise entsprechend der 
Auflösungseinstellung auf der MIDI Preferences-
Registerkarte.

Triangle. – zeichnet ein Sägezahnmuster, das sich 
entsprechend dem aktuellen Rasterwert 
wiederholt. In Audiospuren verfügt das Muster an 
jedem Hoch- und Tiefpunkt über je einen 
Breakpoint. In MIDI-Spuren ändert sich der 
Controller-Wert stufenweise entsprechend der 
Auflösungseinstellung auf der MIDI Preferences-
Registerkarte. Die Amplitude lässt sich durch 
vertikale Bewegungen des Pencil-Tools steuern. 

Square. – zeichnet ein Rechteckmuster, das sich 
entsprechend dem aktuellen Rasterwert 
wiederholt. Die Amplitude lässt sich durch 
vertikale Bewegungen des Pencil-Tools steuern. 
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Random. – zeichnet ein Zufallsmuster von Pegeln, 
das sich entsprechend dem aktuellen Rasterwert 
ändert. Die Amplitude lässt sich durch vertikale 
Bewegungen des Pencil-Tools steuern.

Verwenden der verschiedenen 
Formen des Pencil-Tools
Automationsdaten können sowohl für Audio- als 
auch für MIDI-Spuren gezeichnet werden. 
Beispielsweise können Sie mit Hilfe der Triangle-
Einstellung kontinuierliche Veränderungen oder 
mit der Square-Form eine Schalterfunktion wie 
„Mute“ oder „Bypass“ steuern.

Da das Pencil-Tool diese Formen unter 
Verwendung des aktuellen Rasterwerts zeichnet, 
können Sie das Tool verwenden, um das Panorama 
im Tempo einer Musikspur oder in der 
Postproduktion bei Szenenwechseln zu regeln.

Auflösung von MIDI-Controller-
Daten
Das Zeichnen von MIDI-Automationsdaten mit 
dem Pencil-Tool erfolgt in einzelnen Schritten. Sie 
können die Auflösung (Dichte) dieser Schritte 
steuern, um die Menge an MIDI-Daten besser 
verwalten zu können, die für eine bestimmte 
MIDI-Controller-Bewegung gesendet werden.

So stellen Sie die Auflösung für das Pencil-Tool ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf MIDI.

2 Geben Sie einen Wert für die Option Pencil Tool 

Resolution When Drawing Controller Data ein. 
Dieser Wert kann zwischen 1 und 100 
Millisekunden liegen.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

Die folgenden Abbildungen zeigen identische 
MIDI-Controller-Automationsdaten, die mit 
verschiedenen Auflösungseinstellungen des 
Pencil-Tools gezeichnet wurden.

Um eine höhere Leistung zu erzielen, sollten Sie 
einen kleineren Wert für MIDI-Parameter wählen, 
die eine höhere Auflösung benötigen (etwa MIDI-
Lautstärke) und einen größeren Wert für Regler, 
die keine hohe Auflösung brauchen (etwa 
Panorama).

Die parabolischen und S-Kurven-Formen 
des Pencil-Tools sind nicht zum Bearbeiten 
von Automation verfügbar.

Weitere Informationen zu MIDI Continuous 
Controller-Daten finden Sie unter 
„Continuous Controller-Events“ auf 
Seite 712.

MIDI-Daten, gezeichnet mit einer Auflösung von 10 ms 

MIDI-Daten, gezeichnet mit einer Auflösung von 100 ms 
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Editieren von 
Automationsdaten
Pro Tools bietet für alle Spuren in einer Session 
mehrere Möglichkeiten zum Bearbeiten von 
Automationsdaten, einschließlich der Trim-
Automation, falls sie noch nicht addiert wurde 
(nur Pro Tools HD). Sie können 
Automationsdaten grafisch bearbeiten, indem Sie 
Breakpoints in Automations-Playlists anpassen. 
Sie können Automationsdaten auch in der gleichen 
Weise wie Audio- und MIDI-Daten ausschneiden, 
kopieren und einfügen.

Grafisches Editieren von 
Automationsdaten
Die Automationsdaten werden als Liniendiagramm 
mit editierbaren Breakpoints dargestellt. 

Durch Ziehen dieser Breakpoints lassen sich die 
Automationsdaten direkt im Edit-Fenster und in 
den MIDI Editor-Fenstern editieren. Wenn Sie 
einen Automations-Breakpoint nach oben oder 
unten ziehen, wird die Wertänderung in Zahlen 
oder als Text angezeigt. 

Das Ziehen eines Automations-Breakpoints nach 
links oder rechts ändert den Zeitpunkt, zu dem das 
Automations-Event gesendet wird. 

Um den Automationstyp des Breakpoints auf einer 
Spur anzuzeigen, wählen Sie entweder die 
entsprechende Spurdarstellung aus oder blenden 
Sie die entsprechende Automations- oder 
Controller-Lane unter der Spur ein.

Verwenden des Grabber-Tools

Mit dem Grabber-Tool können Sie durch Klicken 
auf eine Diagrammlinie neue Breakpoints erstellen 
oder durch Ziehen die Position vorhandener 
Breakpoints ändern. Zum Entfernen von 
Breakpoints klicken Sie mit dem Grabber-Tool bei 
gedrückter Alt- (Windows) bzw. Wahltaste (Mac) 
darauf.

Verwenden des Pencil-Tools

Mit dem Pencil-Tool können Sie neue Breakpoints 
erzeugen, indem Sie auf die Diagrammlinie klicken. 
Klicken Sie mit dem Pencil-Tool bei gedrückter 
Alt- (Windows) bzw. Wahltaste (Mac) auf 
Breakpoints, um sie zu entfernen.

Automations-Breakpoint

Automations-Breakpoint-Wert

Verwenden des Grabber-Tools zum Erzeugen eines 
neuen Breakpoints

Verwenden des Pencil-Tools zum Löschen eines 
Breakpoints
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Verwenden des Trim-Tools

Mit dem Trim-Tool können Sie alle selektierten 
Breakpoints nach oben oder unten verschieben, 
indem Sie sie innerhalb der Selektion ziehen.

Bearbeiten von 
Automationstypen
Jedes automatisierbare Steuerelement hat eine 
dazugehörige Playlist, die durch Auswahl im 
Track View-Selektor angezeigt werden kann, 
siehe „Darstellen von Automationsdaten“ auf 
Seite 1081.

Bearbeiten der Lautstärkeautomation

Ziehen Sie einen Breakpoint nach oben oder unten, 
um die Lautstärke (dB-Wert) zu ändern. Ziehen 
Sie einen Breakpoint nach links oder rechts, um 
den Zeitpunkt der Lautstärkeänderung zu ändern.

Bearbeiten der Panorama-Automation

Ziehen Sie einen Breakpoint nach unten, um eine 
Panoramaverschiebung nach rechts zu erreichen, 
und nach oben, um eine Verschiebung nach links zu 
erzeugen. Ziehen Sie einen Breakpoint nach links 
oder rechts, um den Zeitpunkt der 
Panoramaverschiebung anzupassen.

Bearbeiten der Stummschaltungsautomation

Ziehen Sie den Breakpoint nach unten, um den 
Abschnitt stummzuschalten. Ziehen Sie einen 
Breakpoint nach oben, um die Stummschaltung 
aufzuheben. Ziehen Sie einen Breakpoint nach 
links oder rechts, um den Zeitpunkt der 
Stummschaltung zu ändern.

Bearbeiten der Automation gestufter Parameter

Die Automation für bestimmte Parameter (wie MIDI 
Controller-Werte oder Plug-In-Einstellungen) 
erscheint als „Treppe“ auf der Breakpoint-Linie. 
Ziehen Sie einen Breakpoint nach oben oder unten 
auf eine andere Stufe, um einen neuen Parameterwert 
zu erzielen. Ziehen Sie einen Breakpoint nach links 
oder rechts, um den Zeitpunkt der Veränderung des 
gestuften Parameters zu beeinflussen.

Verwenden des Trim-Tools zum Verschieben von 
Breakpoints

Lautstärkeautomation auf einer Spur

Panorama-Automation auf einer Spur

Stummschaltungsautomation auf einer Spur

Automation gestufter Parameter
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Bearbeiten von Automations-
Breakpoints
Zum Bearbeiten von Automations-Breakpoints 
zeigen Sie die Automations-Playlist für den 
gewünschten Parameter an, indem Sie sie im Track 
View-Selektor auswählen. Anschließend haben 
Sie folgende Möglichkeiten:

So erzeugen Sie einen neuen Breakpoint:

 Klicken Sie mit dem Pencil- oder einem 
beliebigen Grabber-Tool auf die Linie.

So bearbeiten Sie einen Breakpoint:

 Klicken Sie mit einem beliebigen Grabber-Tool 
auf einen vorhandenen Punkt auf dem 
Liniendiagramm und ziehen Sie ihn an eine 
neue Position.

So löschen Sie einen Breakpoint:

 Klicken Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) mit einem Grabber-Tool.

So bearbeiten Sie mehrere Breakpoints 
gleichzeitig:

 Selektieren Sie mit Hilfe des Selector-Tools 
einen Bereich in der Automations-Playlist, der 
die Breakpoints enthält. Anschließend haben 
Sie folgende Möglichkeiten:

• Um die Breakpoints an eine spätere Position (nach 
rechts) in der Spur zu verschieben, drücken Sie auf 
das Pluszeichen (+). Um sie mit der Nudge-
Funktion an eine frühere Position (nach links) zu 
verschieben, drücken Sie auf das 
Minuszeichen (–). Die Breakpoints werden um 
den aktuellen Nudge-Wert verschoben.

• Zum Einstellen der Breakpoint-Werte klicken 
Sie mit einem der Trim-Tools in die Selektion 
und ziehen Sie die Breakpoints aufwärts 
oder abwärts.

So bearbeiten Sie alle Breakpoint-Werte in 
einem Clip:

 Klicken Sie mit einem beliebigen Trim-Tool in 
den Clip und ziehen Sie die Breakpoints nach 
oben oder unten.

Beschränken neuer Breakpoints 
auf den nächsten oder vorigen 
Automationswert
Neue Automations-Breakpoints können 
beschränkt und auf den Wert des nächsten oder 
vorigen Breakpoints geschrieben werden.

Wenn Sie eine Selektion, die Breakpoints 
enthält, mit der Nudge-Funktion 
verschieben, werden bei Bedarf neue Anker-
Breakpoints erstellt, um den Verlauf der 
Automation innerhalb der Selektion 
beizubehalten. 

Wenn Sie ein Trim-Tool verwenden, um eine 
Selektion mit Breakpoints zu bearbeiten, 
werden neue Anker-Breakpoints am Anfang 
und Ende der Selektion erzeugt. Um die 
Erzeugung von Anker-Breakpoints zu 
unterdrücken, verwenden Sie das Trim-Tool 
bei gedrückter Alt-Taste (Windows) bzw. 
Wahltaste (Mac). 

Beschränken und Schreiben neuer Breakpoints 
(an Marker 1)

Nach dem Schreiben auf den

Wert des nächsten Breakpoints

Nach dem Schreiben auf den Wert des 

vorigen Breakpoints

Ursprüngliche Automation
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So schreiben Sie einen neuen Breakpoint auf den 
nächsten Automationswert:

 Halten Sie Alt + Umschalt (Windows) bzw. 
Wahl + Umschalt (Mac) gedrückt, während Sie 
den Breakpoint durch Klicken mit einem 
beliebigen Grabber-Tool in die Automations-
Playlist der betreffenden Spur schreiben.

So schreiben Sie einen neuen Breakpoint auf den 
vorigen Automationswert:

 Halten Sie Strg + Alt (Windows) bzw. Befehl + 
Wahl (Mac) gedrückt, während Sie den 
Breakpoint durch Klicken mit einem beliebigen 
Grabber-Tool in die Automations-Playlist der 
betreffenden Spur schreiben.

Editieren von Automationsdaten 
auf Stereo- und Mehrkanalspuren
Bei Stereo- und Mehrkanalspuren wird eine 
einzige Automations-Playlist pro Spur und eine 
Playlist für die Lautstärke und Stummschaltung 
angezeigt.

Plug-In-Automations-Playlists auf Stereo- und 
Mehrkanalspuren

Bei einigen Mehrkanal-Plug-Ins können alle 
Kanäle über einen einzigen Satz automatisierbarer 
Steuerelemente geregelt werden. Bei anderen 
Mehrkanal-Plug-Ins und bei allen Multimono-
Plug-Ins können alle Kanäle mit einem einzigen 
Satz von Steuerelementen geregelt werden, wenn 
sie vorher gekoppelt werden. Ohne Koppelung 
wird jeder Kanal über ein getrenntes 
Steuerelement geregelt. Weitere Informationen 
dazu finden Sie im Handbuch zu Ihrem Plug-In.

Für Multimono-Plug-Ins können Automations-
Playlists für jeden einzelnen Kanal angezeigt und 
editiert werden, wenn das Plug-In nicht gekoppelt 
und die Spur in Automations-Lanes angezeigt 
wird. 

So können Sie die einzelnen Playlists eines 
Multimono-Plug-Ins anzeigen und editieren:

1 Heben Sie die Kopplung des Plug-Ins auf. 

2 Wählen Sie die Automations-Playlist im Track 
View-Selektor oder blenden Sie sie auf einer 
Automations-Lane unter der Spur ein.

Das Smart-Tool kann nicht verwendet 
werden, um neue Breakpoints auf den 
nächsten oder vorigen Automationswert zu 
schreiben.

Auswählen einer Automations-Lane für ein nicht 
gekoppeltes Multimono-Plug-In-Steuerelement
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Editieren von Automationsdaten 
auf gruppierten Spuren
Wenn Sie Automationsdaten auf einer Audiospur 
editieren, die Teil einer aktiven Edit-Gruppe ist, 
werden alle Automationsdaten dieses Typs auf 
allen Spuren dieser Gruppe geändert. Dies ist auch 
der Fall, wenn die Playlist für diesen 
Automationstyp derzeit auf den anderen 
gruppierten Spuren nicht angezeigt wird.

Beispiele

 Wenn Sie auf einer gruppierten Spur neue 
Automations-Breakpoints erzeugen (mit dem 
Pencil- oder einem beliebigen Grabber-Tool), 
werden bei den anderen Elementen der Gruppe 
Breakpoints relativ zu dieser Spur positioniert.

 Wenn Sie auf einer gruppierten Spur die 
Automation (mit einem beliebigen Trim-Tool) 
verschieben, werden bei den anderen Elementen 
der Gruppe die Breakpoints relativ zu dieser Spur 
getrimmt. Dadurch können ganze Abschnitte einer 
Mischung getrimmt werden.

Führen Sie einen der folgenden Schritte aus, 
um eine Automation einzeln für ein Mitglied einer 
Gruppe zu bearbeiten, ohne die anderen Mitglieder 
zu beeinträchtigen:

 Halten Sie beim Editieren die Windows-Taste 
(Windows) bzw. die Ctrl-Taste (Mac) gedrückt.

Ausschneiden, Kopieren und 
Einfügen von 
Automationsdaten
Das Ausschneiden von Automationsdaten 
unterscheidet sich vom Löschen und führt zu 
anderen Ergebnissen. (Bei beiden Vorgängen 
werden vorhandene Automationsdaten verändert.) 
Beim Kopieren von Automationsdaten bleiben die 
Originaldaten unverändert.

Sie löschen Automationsdaten, indem Sie einen 
Abschnitt mit Breakpoints selektieren und die 
Rücktaste (Windows) bzw. Entf-Taste (Mac) 
drücken. Weitere Informationen finden Sie unter 
„Löschen von Automationsdaten“ auf Seite 1098.

Sie können Automationsdaten ausschneiden, 
indem Sie einen Bereich von Breakpoints in einer 
Automations-Playlist selektieren und den Cut-
Befehl auswählen.

Wenn Sie Automationsdaten ausschneiden und an 
einer neuen Position einfügen, werden am Anfang 
und Ende der Daten Anker-Breakpoints 
hinzugefügt. Dadurch bleibt der richtige 
Regelverlauf (von Steuerelementen wie etwa 
Lautstärke- oder Panoramareglern) bzw. der echte 
Zustand (von Schaltern oder gestuften Parametern 
wie etwa Stummschaltungen) der 
Automationsdaten sowohl innerhalb als auch 
außerhalb des selektierten Bereichs erhalten.

Die folgenden Abbildungen zeigen den 
Unterschied zwischen dem Ausschneiden und dem 
Löschen von Automationsdaten. In der folgenden 
Abbildung ist eine Spur so eingestellt, dass 
Lautstärkeautomation angezeigt wird, wobei ein 
Bereich von Automationsdaten selektiert ist.Trim-Automation auf einer Spur einer aktiven Gruppe

Selektieren von Automationsdaten
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Wenn der Cut-Befehl gewählt wurde, werden 
Anker-Breakpoints an beiden Enden der Selektion 
erzeugt und der Automationsverlauf bleibt auf 
beiden Seiten der ausgeschnittenen Daten erhalten 
(siehe dazu die folgende Abbildung). 

Wenn die Daten durch Drücken auf die Rücktaste 
(Windows) bzw. Entf-Taste (Mac) gelöscht 
wurden, werden die Automationsdaten entfernt 
und Automationswerte schließen die Lücke 
zwischen den schon vorhandenen Breakpoints 
(siehe dazu die folgende Abbildung). 

Außerdem werden beim Einfügen von 
ausgeschnittenen oder kopierten Daten an einer 
beliebigen Stelle in der Spur Breakpoints an den 
Endpunkten der eingefügten Daten erzeugt, sodass 
der benachbarte Wert und der Verlauf (eingehend 
und ausgehend) der Automation erhalten bleiben 
(siehe dazu die folgende Abbildung).

Editieren und Spurarstellungen
Audio-, MIDI- und Instrumentenspuren haben 
jeweils eine bestimmte Spurdarstellung, die als 
Master-Darstellung zum Editieren dienen. Wenn 
diese Master-Darstellung angezeigt wird, werden 
alle Edits, die auf der Spur ausgeführt werden, auf 
alle Daten in der Spur angewendet.

Es gibt folgende Master-Darstellungen:

• Audiospuren: „Blocks“ und „Waveform“

• MIDI- und Instrumentenspuren: „Blocks“, 
„Clips“ und „Notes“

Wenn die Darstellung einer Audiospur 
beispielsweise auf „Waveform“ oder „Blocks“ 
eingestellt ist, wirkt sich das Ausschneiden, 
Kopieren und Einfügen auf die Audiodaten und 
alle Arten von Automationsdaten auf dieser Spur 
aus. Wenn die Spur so eingestellt ist, dass 
Panorama-Automation angezeigt wird, werden nur 
die Panoramadaten beeinflusst.

Wenn eine Selektion mehrere Spuren beinhaltet 
und eine dieser Spuren in der Master-Darstellung 
angezeigt wird, werden alle Daten auf allen 
selektierten Spuren beeinflusst.

Um alle Automationstypen auf einer Auxiliary-
Eingangs- oder Master-Fader-Spur zu editieren, 
gehen Sie folgendermaßen vor:

 Nehmen Sie eine Edit-Selektion mit mindestens 
einer Audio- oder MIDI-Spur vor, die im 
Hauptformat dargestellt wird.

 Halten Sie beim Ausschneiden oder Kopieren 
der Automationsdaten die Strg- (Windows) 
bzw. Ctrl-Taste (Mac) gedrückt. 

Nach dem Ausschneiden der Automationsdaten

Nach dem Löschen der Automationsdaten

Nach dem Einfügen von Automationsdaten an einer 
anderen Position

Um zusätzliche Flexibilität zu erreichen, 
können Sie Playlists oder den Duplicate 
Track-Befehl verwenden, um nicht 
destruktiv mit einer Kopie der zu 
editierenden Daten zu arbeiten. 
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Tipps zum Ausschneiden, 
Kopieren und Einfügen von 
Automationsdaten
 Wenn sich Audiospuren in der Waveform-
Darstellung befinden und Sie einen Abschnitt der 
Wellenform ausschneiden oder kopieren, werden 
auch die dazugehörigen Automationsdaten 
ausgeschnitten oder kopiert.

 Wenn sich Audiospuren in der Waveform-
Darstellung befinden und Sie Audiodaten einer 
Spur ausschneiden, die auch Automationsdaten 
enthält, werden automatisch Breakpoints an 
den Enden der verbleibenden Automationsdaten 
erzeugt.

 Beim Einfügen von Wellenformdaten in 
Audiospuren werden auch die dazugehörigen 
Automationsdaten eingefügt. 

 Bei Auxiliary-Eingangs-, Master-Fader- oder 
Instrumentenspuren werden nur die angezeigten 
Automationsdaten ausgeschnitten oder kopiert. 
Um die gesamte Automation solcher Spuren 
auszuschneiden oder zu kopieren, müssen Sie 
während des Ausschneidens oder Kopierens 
die Strg- (Windows) bzw. Ctrl-Taste (Mac) 
gedrückt halten.

 Enthält eine Spur eine Automations-Playlist, 
die keine Daten beinhaltet (also nur einen einzigen 
Breakpoint am Anfang der Spur), werden beim 
Ausschneiden von Daten keine neuen Breakpoints 
erzeugt.

 Wenn Clips sich überlappen (etwa durch 
Verschieben der Clips im Slip-Modus) und einer der 
überlappenden Clips gelöscht wird, gehen die 
überlappenden Automations-Breakpoints verloren.

 Wenn Sie Daten ausschneiden oder kopieren, 
die einen Automationstyp enthalten, der auf der 
Zielspur noch nicht angelegt ist, weist Pro Tools 
Sie darauf hin, bevor Sie die Daten einfügen 
können. 

 Ausgeschnittene oder kopierte 
Automationsdaten für Plug-Ins und Sends, 
die auf der Zielspur nicht existieren, werden beim 
Einfügen ignoriert.

Spezialbefehle zum 
Ausschneiden, Kopieren, 
Löschen und Einfügen
Die vier „Spezialbefehle“ (Cut Special, Copy 
Special, Paste Special und Clear Special) 
vereinfachen die Arbeit beim Verschieben oder 
Löschen verschiedener Typen von 
Automationsdaten und MIDI-Controller-Daten 
auf Spuren, Sends und Plug-Ins. Diese Befehle 
bieten Ihnen folgende Möglichkeiten:

• Ausschließliches Bearbeiten von Automations- 
und MIDI-Controller-Daten (ohne die damit 
verknüpften Audio- oder MIDI-Noten)

• Editieren von Automations- und MIDI-
Controller-Daten ohne Notwendigkeit, die 
Spurdarstellung zu ändern

Darüber hinaus können Sie mit dem Paste Special-
Befehl die Daten eines Datentyps in einen anderen 
kopieren (Beispiel: Daten für linkes Panorama in 
Playlist für rechtes Panorama).

Cut Special

Mit den Cut Special-Befehlen können Sie die 
Automationsdaten der aktuellen Selektion (ohne 
die verknüpften Audio- oder MIDI-Noten) 
ausschneiden und wie nachfolgend beschrieben im 
Zwischenspeicher ablegen, um sie an anderer 
Stelle einzufügen. Es stehen folgende 
Möglichkeiten zur Auswahl:

All Automation. – schneidet sämtliche 
Automations- oder MIDI-Controller-Daten aus, 
ohne Rücksicht darauf, ob sie eingeblendet sind 
oder nicht. 

Pan Automation. – schneidet nur Panorama-
Automations- oder MIDI-Pan-Daten aus, ohne 
Rücksicht darauf, ob sie eingeblendet sind oder 
nicht.

Plug-In Automation. – schneidet nur die 
angezeigten Plug-In-Automationsdaten aus.

Es ist nicht möglich, MIDI-Controller-Daten in 
Automationsdaten einzufügen oder umgekehrt.
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Copy Special

Mit den Copy Special-Befehlen können Sie die 
Automationsdaten der aktuellen Selektion (ohne 
die verknüpften Audio- oder MIDI-Noten) 
kopieren und wie folgt im Zwischenspeicher 
ablegen, um sie an anderer Stelle einzufügen:

All Automation. – kopiert sämtliche Automations- 
oder MIDI-Controller-Daten, ohne Rücksicht 
darauf, ob sie eingeblendet sind oder nicht. 

Pan Automation. – kopiert nur Panorama-
Automations- oder MIDI-Pan-Daten, ohne 
Rücksicht darauf, ob sie eingeblendet sind oder nicht.

Plug-In Automation. – kopiert nur die angezeigten 
Plug-In-Automationsdaten.

Paste Special

Mit den Paste Special-Befehlen haben Sie 
folgende Möglichkeiten, Automationsdaten in 
andere Clips einzufügen (ohne dass verknüpfte 
Audio- oder MIDI-Noten davon betroffen sind): 

Zusammenführen. – mit diesem Befehl können Sie 
bereits bestehenden Automationsdaten desselben 
Typs in der Zielselektion Daten aus dem 
Zwischenspeicher hinzufügen. Dies ist ggf. nützlich 
beim Zusammenfügen von MIDI-Daten aus 
mehreren Spuren auf einer einzelnen MIDI-Spur. 
Beispiel: Ihnen gefällt die Tonhöhenbeugung der 
Synthesizer-Trompeten und Sie möchten sie auch 
auf die Synthesizer-Gitarre anwenden.

Repeat to Fill Selection. – fügt mehrere Kopien 
der Automationsdaten in den gesamten 
selektierten Bereich ein. Wenn der selektierte 
Bereich kein ganzes Vielfaches der Größe des 
kopierten Clips darstellt, wird der verbleibende 
Abschnitt der Selektion mit einer getrimmten 
Version der Originalselektion ausgefüllt. Dies 
ermöglicht Ihnen ein leichtes Erstellen von 
Schlagzeug-Loops und anderen sich 
wiederholenden Effekten. Bevor die Daten 
eingefügt werden, fordert Pro Tools Sie dazu auf, 
einen Crossfade anzugeben, um die Übergänge 
zwischen den Clips fließend zu gestalten. 

To Current Automation Type. – fügt die 
Automations- oder MIDI-Controller-Daten aus der 
Zwischenablage mit dem aktuellen Automationstyp 
oder MIDI-Controller in die Selektion ein. Mit dieser 
Funktion können Sie Automationsdaten beliebiger 
Art in Automationsdaten beliebiger anderer Typen 
kopieren. Beispiel: Sie können Automationsdaten für 
linkes Panorama in Plug-In-Automationsdaten 
kopieren Sie können auch MIDI-Lautstärkedaten 
kopieren und in das MIDI-Panorama einfügen.

Clear Special

Mit den Clear Special-Befehlen können Sie wie 
folgt die Automationsdaten aus dem aktuellen Clip 
löschen:

All Automation. – löscht sämtliche Automations- 
oder MIDI-Controller-Daten, ohne Rücksicht 
darauf, ob sie eingeblendet sind oder nicht. 

Pan Automation. – löscht nur Panorama-
Automations- oder MIDI-Pan-Daten, ohne 
Rücksicht darauf, ob sie eingeblendet sind oder 
nicht.

Plug-In Automation. – löscht nur die angezeigten 
Plug-In-Automationsdaten.

Special Paste-Funktion für 
Automationsdaten
Normalerweise werden kopierte 
Automationsdaten in eine Automations-Playlist 
desselben Typs eingefügt (etwa werden die Daten 
für linkes Panorama in die Playlist für linkes 
Panorama eingefügt). 

Es kann jedoch vorkommen, dass Sie Daten eines 
Datentyps in einen anderen kopieren möchten 
(Beispiel: Daten für linkes Panorama in Playlist für 
rechtes Panorama).

Mit dem Special Paste-Befehl können Sie einen 
Datentyp in einen anderen kopieren. 
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Verwenden Sie den Paste Special-Befehl, wenn 
Sie ausschließlich Automations- oder MIDI-
Controller-Daten (ohne die damit verknüpften 
Audio- oder MIDI-Noten) einfügen möchten.

Damit der Special Paste-Modus funktionieren 
kann, gelten folgende Voraussetzungen:

• Jede Spur, in die Daten eingefügt werden sollen, 
muss gegenwärtig Automationsdaten anzeigen.

• Es darf sich nur eine Automations-Playlist pro 
Zielspur im Zwischenspeicher befinden. (Mit 
dem Special Paste-Befehl können nicht mehrere 
Automations-Playlists pro Spur eingefügt 
werden.)

So fügen Sie Daten in eine andere Automations-
Playlist ein:

 Wählen Sie bei gedrückter Windows-Taste 
(Windows) bzw. Ctrl-Taste (Mac) Edit > Paste.

Umwandeln von 
Lautstärkeautomation und Clip-
Gain
(Nur Pro Tools HD)

Pro Tools ermöglicht das Umwandeln von Clip-
Gain-Einstellungen in spurbasierte 
Lautstärkeautomation sowie das Umwandeln 
spurbasierter Lautstärkeautomation in Clip-Gain-
Einstellungen. Weitere Informationen finden Sie 
unter „Konvertieren von Clip-Gain 
in Lautstärkeautomation für Spuren“ auf 
Seite 618.

Addieren von 
Lautstärkeautomation und Glip-
Gain
(Nur Pro Tools HD)

In Pro Tools können Sie die Werte der Clip-Gain-
Einstellungen zu denen der spurbasierten 
Lautstärkeautomation sowie die Werte 
spurbasierter Lautstärkeautomation zu denen der 
Clip-Gain-Einstellungen addieren. Weitere 
Informationen finden Sie unter „Addieren von Clip-
Gain und Lautstärkeautomation“ auf Seite 619.

Glide-Automation
(Nur Pro Tools HD)

Mit den Glide Automation-Befehlen können Sie 
manuell einen Automationsübergang (oder „Glide“) 
von einem bestehenden Automationswert zu einem 
neuen erstellen (über einen selektierten Bereich).

So wenden Sie eine Glide-Automation auf den 
aktuellen Automationsparametertyp an:

1 Im Automation-Fenster muss der 
Automationstyp für die Aufzeichnung aktiviert 
sein (write-enabled).

2 Klicken Sie auf den Track View-Selektor, um 
den Automationstyp auszuwählen, auf den die 
Automation angewendet werden soll. 

3 Ziehen Sie das Selector-Tool in die Spur, um 
den Bereich, auf den Sie den Glide schreiben 
möchten, zu selektieren.

Sie können Automationsdaten weder 
zwischen Audio- und MIDI-Spuren 
austauschen noch zwischen Continuous 
Controllern (etwa Fadern oder 
Panoramareglern) und Schaltern bzw. 
gestuften Steuerelementen (etwa der 
Stummschaltung oder MIDI-Controllern). Verwenden Sie die Optionsfolge „Edit > 

Automation > Glide to All Enabled“, wenn Sie 
für mehrere Parameter gleichzeitig einen 
Übergang herstellen, wie beispielsweise mit 
Surround-Panner oder Plug-Ins.

Bei der MIDI-Automation gelten Glide To-
Befehle nur für MIDI-Lautstärke, MIDI-Pan 
und MIDI-Mute. MIDI-Parameter können 
die Write To-Befehle nicht verwenden.
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4 Ändern Sie den Automationsparameter auf den 
gewünschten Wert am Ende der Selektion. 
Beispiel: Wenn Sie einen Automationsübergang 
der Lautstärke auf „–unendlich“ herstellen 
möchten, müssen Sie den Lautstärke-Fader auf 
„–unendlich“ einstellen.

5 Wählen Sie Edit > Automation > Glide to 
Current.

So wenden Sie eine Glide-Automation auf alle 
derzeit aktivierten Parameter an:

1 Im Automation-Fenster müssen die 
Automationstypen für die Aufzeichnung 
aktiviert sein (write-enabled).

2 Klicken Sie in jeder Spur, die Sie 
automatisieren möchten, auf den Track View-
Selektor und wählen Sie im Popup-Menü den 
gewünschten Automationstyp aus.

3 Ziehen Sie mit dem Selector-Tool in 
horizontaler Richtung, um alle Spuren, die Sie 
automatisieren möchten, in die Selektion 
einzubeziehen. (Ziehen Sie vertikal, um den 
Zeitbereich zu definieren.)

4 Ändern Sie in jeder Spur, den Sie 
automatisieren möchten, den 
Automationsparameter auf den gewünschten 
Wert am Ende der Selektion.

5 Wählen Sie Edit > Automation > Glide to All 
Enabled.

Überlegungen zur Glide-
Automation
Wenn Glide-Automation auf Automationsdaten 
angewendet wird, ist deren Verhalten wie folgt:

• Wenn eine Auswahl getroffen wird, werden 
Automations-Breakpoints an die Start- und 
Endpunkte der Glide-Automation geschrieben. 
Der Automationswert am Anfang der Selektion 
ist der Ausgangspunkt und das Ende der 
Selektion der Endpunkt für die Glide-
Automation. Die zwischen diesen beiden 
Punkten erstellte Glide-Automation basiert auf 
der Länge der Selektion und dem ausgewählten 
Endwert für die Automation.

• Wenn nach der Selektion Automations-
Breakpoints auftreten, werden diese nicht 
geändert, aber der für das Selektionsende 
ausgewählte Wert wird vom Endpunkt der 
Selektion bis zum nächsten Breakpoint 
geschrieben.

• Gibt es nach dem selektierten Bereich keine 
Automations-Breakpoints, wird der für das 
Selektionsende ausgewählte Wert bis zum Ende 
der Spur fortgeschrieben.

• Wenn keine Selektion vorgenommen wird, 
wird an der aktuellen Position ein Breakpoint 
geschrieben und der für die Glide-Automation 
ausgewählte Wert wird bis zum nächsten 
Breakpoint fortgeschrieben.

Sie können auch die Alt- (Windows) bzw. 
Wahl- (Mac) und die Schrägstrich-Taste (/) 
drücken.

Sie können auch die Alt- (Windows) bzw. 
Wahl- (Mac), die Umschalt- und die 
Schrägstrich-Taste (/) drücken.
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Trimmen von 
Automationsdaten
(Nur Pro Tools HD)

Wenn Sie bereits Automation aufgezeichnet 
haben, können Sie mit Hilfe des Trim-Modus 
Automationsdaten für Spurlautstärke und Send-
Pegel in Echtzeit ändern. Wenn eine Spur für das 
Trimmen aktiviert ist, werden keine absoluten 
Fader-Positionen aufgezeichnet, sondern relative 
Änderungen an der bestehenden Automation. 
Weitere Hinweise finden Sie unter „Trim-Modus“ 
auf Seite 1077.

So aktivieren Sie den Trim-Modus:

 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor der Spur, für die 
Sie die Automation trimmen möchten, und 
wählen Sie Trim.

Wenn der Trim-Modus einer Spur aktiviert wurde, 
werden ihre Lautstärke- und Send-Pegel-Fader 
gelb dargestellt und der Automation Mode-
Selektor gelb umrahmt. Diese Umrahmung ist 
konstant rot, wenn der Trim-Modus für die Spur 
aktiviert wurde, und blinkt, wenn Spurlautstärke 
oder Send-Pegel gerade getrimmt werden. 

Aufzeichnung der Trim-
Automation
Die Aufzeichnung der Trim-Automation richtet 
sich nach den Einstellungen für das Addieren. 
Siehe „Addieren der Trim-Automation“ auf 
Seite 1112. Wenn die Aufzeichnung nicht so 
eingerichtet ist, dass sie nach jedem 
Automationsdurchgang addiert wird, werden 
Trim-Automationsbewegungen in eine separate 
Trim-Playlist geschrieben. 

So trimmen Sie die Lautstärke oder Send-Pegel 
einer Spur:

1 Im Automation-Fenster muss der 
Automationstyp (Lautstärke- oder Send-Pegel) 
für die Aufzeichnung aktiviert sein (write-
enabled).

2 Klicken Sie in der Spur, für die Sie die 
Automationsaufzeichnung durchführen 
möchten, auf den Automation Mode-Selektor 
und wählen Sie den Automationsmodus 
(Touch, Latch, Touch/Latch oder Write). 

3 Klicken Sie auf den Automation Mode-Selektor 
und wählen Sie Trim.

4 Starten Sie die Wiedergabe und passen Sie die 
Lautstärke- oder Send-Pegel an.

5 Halten Sie die Wiedergabe an, um den Trim-
Durchgang zu beenden. 

Addieren der Trim-Automation
Sie können Pro Tools so einrichten, dass die Trim-
Automation in die Haupt-Automations-Playlist 
übernommen oder damit addiert wird. Hierfür 
stehen Ihnen folgende Methoden zur Verfügung:

After Every Pass. – Trim-Bewegungen werden 
automatisch angewendet, wenn der Transport am 
Ende eines Automationsdurchgangs angehalten 
wird. Trim-Automations-Playlists werden 
bereinigt, und Trim-Fader werden auf Null 
zurückgesetzt.

Aktivieren des Trim-Modus
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On Exiting Trim Mode. – Trim-Bewegungen 
werden separat in der Trim-Automations-Playlist 
gespeichert, bis sie addiert werden. Die Trim-
Automation wird nur dann automatisch mit einer 
Spur addiert, wenn Sie den Trim-Modus für die 
Spur aufheben. Sie können einen 
Automationsdurchgang wiederholen, die Trim-
Automation manuell in einer der Trim-Playlists 
bearbeiten oder die Trim-Automation vor dem 
Addieren mit dieser Methode bereinigen.

Manuell. – Trim-Bewegungen werden separat in 
der Trim-Automations-Playlist gespeichert, bis sie 
addiert werden. Bei dieser Einstellung stellt der 
Coalesce Trim Automation-Befehl die einzige 
Möglichkeit zum Addieren von Trim-
Bewegungen dar. Sie können einen 
Automationsdurchgang wiederholen, die Trim-
Automation manuell in einer der Trim-Playlists 
bearbeiten oder die Trim-Automation vor dem 
Addieren mit dieser Methode bereinigen. 

So bestimmen Sie die Methode zum Addieren der 
Trim-Automation:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Wählen Sie unter „Coalesce Trim Automation“ 
eine der folgenden Optionen aus:

• After Every Pass 

• On Exiting Trim Mode 

• Manuell 

So addieren Sie die Trim-Automation auf einer 
Spur beim Verlassen des Trim-Modus:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Aktivieren Sie unter „Coalesce Trim 
Automation“ die On Exiting Trim Mode-Option.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

4 Stellen Sie sicher, dass der Transport in 
Pro Tools angehalten ist.

5 Klicken Sie auf der Spur, mit der Sie die Trim-
Automation addieren möchten, auf den 
Automation Mode-Selektor und deaktivieren 
Sie Trim.

Die Trim-Automation wird auf die Haupt-
Automations-Playlist angewendet, Trim-
Automations-Playlists werden bereinigt und Trim-
Fader werden auf Null zurückgesetzt. 

So addieren Sie die Trim-Automation manuell mit 
einer Spur:

1 Wählen Sie die Spur, mit der Sie die Trim-
Automation addieren möchten.

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Coalesce Trim Automation.

• Klicken Sie mit der rechten Maustaste auf 
den Spurnamen und wählen Sie Coalesce Trim 

Automation.

Die Trim-Automation wird auf die Haupt-
Automations-Playlist angewendet, Trim-
Automations-Playlists werden bereinigt und Trim-
Fader werden auf Null zurückgesetzt.

Auch wenn die Automation so eingerichtet ist, 
dass sie beim Verlassen des Trim-Modus 
addiert wird, können Sie Trim-Bewegungen 
jederzeit mit dem Coalesce Trim Automation-
Befehl bestätigen.

Wenn der Transport läuft und Sie die 
Automation aufzeichnen, können Sie den Trim-
Modus nicht direkt aktivieren oder verlassen. 
Vor dem Verlassen des Trim-Modus müssen 
Sie die AutoMatch-Funktion ausführen. 
Dadurch werden abrupte Sprünge bei den 
Automationswerten vermieden. 
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Schreiben von Automation 
bis zum Anfang, Ende oder 
für eine gesamte Spur oder 
eine Selektion
(Nur Pro Tools HD)

Pro Tools ermöglicht es, während eines 
Automationsdurchgangs aktuelle 
Automationswerte von einem beliebigen 
Einfügepunkt aus zu schreiben, und zwar vorwärts 
(bzw. rückwärts) bis zum Ende (bzw. Anfang) 
einer Spur, einer Edit-Selektion auf einer Spur 
oder auf eine ganze Spur oder eine ganze Edit-
Selektion.

Die Standardbefehle Write Automation to Start, 
Write Automation to All und Write Automation to 

End sind wirkungslos, wenn der Transport in 
Pro Tools angehalten ist. Sie haben lediglich eine 
Auswirkung auf die Automation der Parameter, die 
gegenwärtig für die Aufzeichnung aktiviert sind 
und Automationsdaten aufzeichnen. 

Sie können die Befehle Write Automation to Start, 
Write Automation to All und Write Automation to 

End bei Bedarf so konfigurieren, dass sie immer 
automatisch angewendet werden. Siehe „Schreiben 
von Automation bis zum Anfang, Ende oder für 
eine gesamte Spur oder Selektion im On Stop-
Modus“ auf Seite 1116. 

Anforderungen für 
Standardbefehle zum Schreiben 
von Automation
Damit Automationsdaten für einen bestimmten 
Parameter geschrieben werden können, muss sich 
die dazugehörige Spur in einem der folgenden 
Automationsmodi befinden und folgende 
Bedingungen erfüllen:

Latch-Modus. – das Steuerelement für den 
Parameter muss während des 
Automationsdurchgangs geändert (berührt) werden. 

Touch-Modus. – das Steuerelement für den 
Parameter muss geändert (berührt) werden. 

Write-Modus. – alle Steuerelemente auf dieser 
Spur müssen sich im Write-Modus befinden. 

Dieser Befehl kann rückgängig gemacht werden.Write Automation to Start-, End- und All-Schaltflächen 
im Automation-Fenster

Bei der MIDI-Automation gelten Write To-
Befehle nur für MIDI Volume, MIDI Pan und 
MIDI Mute. MIDI-Parameter können die 
Write To-Befehle nicht verwenden.
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So schreiben Sie aktuelle Automationswerte bis 
zum Anfang, Ende oder in beide Richtungen der 
Spur bzw. der Edit-Selektion:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp für 
die Aufzeichnung aktiviert (write-enabled) ist.

3 Sie haben folgende Möglichkeiten:

• Klicken Sie an dem gewünschten Einfügepunkt 
in die Spur.

• Ziehen Sie mit dem Selector-Tool, um einen 
Bereich der Spur zu selektieren.

4 Starten Sie die Wiedergabe.

5 Vergewissern Sie sich im Latch- oder Touch-
Modus, dass Sie aktiv auf der entsprechenden 
Spur schreiben.

6 Wenn Sie die Stelle auf der Spur oder in der 
Selektion erreichen, wo sich die gewünschten 
Automationsdaten befinden, klicken Sie im 
Automation Enable-Fenster auf die 
Schaltfläche Write Automation to Start, Write 

Automation to All oder Write Automation to End. 

7 Halten Sie die Wiedergabe an.

Die aktuellen Werte aller für die Aufzeichnung 
aktivierten Automationsparameter an diesem 
Punkt werden nun an die entsprechende Stelle der 
Spur bzw. der Selektion geschrieben.

„Write to Start“, „Write to All“ 
oder „Write to End“ und Trim-
Modus
Während Sie sich im Trim-Modus befinden, ist es 
auch möglich, Trim-Deltawerte für Spurlautstärke 
und Send-Pegel bis zum Anfang, Ende oder für die 
gesamte Spur oder eine Edit-Selektion zu 
schreiben. 

So schreiben Sie aktuelle Trim-Deltawerte bis zum 
Anfang, Ende oder in beide Richtungen der Spur 
bzw. der Selektion:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp 
(Spurlautstärke oder Send-Pegel) für die 
Aufzeichnung aktiviert ist (write-enabled).

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor der Spur, für die Sie 
die Automation trimmen möchten, und wählen 
Sie Trim. Die Fader für Spurlautstärke und Send-
Pegel werden nun gelb dargestellt.

4 Sie haben folgende Möglichkeiten:

• Klicken Sie an dem gewünschten Einfügepunkt 
in die Spur.

• Ziehen Sie mit dem Selector-Tool, um einen 
Bereich der Spur zu selektieren.

5 Klicken Sie auf „Play“, um die Wiedergabe zu 
starten. 

6 Wenn Sie die Stelle auf der Spur oder in der 
Selektion erreichen, wo sich die gewünschte 
Trim-Einstellung (Deltawert) befindet, klicken 
Sie im Automation-Fenster auf die Schaltfläche 
Write Automation to Start, Write Automation to 

All oder Write Automation to End.

7 Halten Sie die Wiedergabe an. 

Die relativen Änderungen an der Spurlautstärke 
und den Send-Pegeln, die Sie an dieser Stelle 
vornehmen, werden im entsprechenden Bereich 
der Spur/Selektion aufgezeichnet.
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Schreiben von Automation bis 
zum Anfang, Ende oder für eine 
gesamte Spur oder Selektion im 
On Stop-Modus
Das Automation-Fenster enthält Optionen für das 
Schreiben von Automation auf Automations-
Playlists (einschließlich Trim-Playlist), nachdem ein 
gültiger Automationsdurchgang ausgeführt wurde. 

Die Write Automation to Start-, End- oder All-
Modi können so konfiguriert werden, dass sie nach 
einem gültigen Automationsdurchgang deaktiviert 
werden oder aktiviert bleiben.

Siehe „Anforderungen für Standardbefehle zum 
Schreiben von Automation“ auf Seite 1114. 

So konfigurieren Sie Write on Stop-Modi so, dass 
sie nach einem Automationsdurchgang 
deaktiviert werden:

1 Wählen Sie Window > Automation.

2 Klicken Sie auf einen der Write On Stop-Modi 
(Start, All oder End).

Der Pfeil auf der so aktivierten Schaltfläche wird 
blau dargestellt.

So konfigurieren Sie Write on Stop-Modi so, 
dass sie nach einem Automationsdurchgang 
aktiviert bleiben:

1 Wählen Sie Window > Automation.

2 Drücken Sie die Alt- (Windows) bzw. Wahltaste 
(Mac) und klicken Sie auf eine der Write On 
Stop-Schaltflächen („Start“, „All“ oder „End“), 
um den betreffenden Write On Stop-Modus 
zu aktivieren.

Der Pfeil auf der so aktivierten Schaltfläche wird 
rot dargestellt.

Schreiben von Automation 
bis zum nächsten Breakpoint 
oder Punch-Punkt
(Nur Pro Tools HD)

Während Sie einen Automationsdurchgang 
ausführen, können Sie in Pro Tools aktuelle 
Automationswerte ab dem aktuellen Einfügepunkt 
vorwärts bis zum nächsten Automations-Breakpoint 
oder zurück zum Punch-Punkt (die Stelle in der 
Spur, an der die Automationsaufzeichnung 
begonnen hat) schreiben. 

 Mit der Write Automation to Next Breakpoint-
Option können Sie Automationsdaten innerhalb 
einer Spur aktualisieren, ohne Automationsdaten, 
die sich an einer Position früher oder später in der 
Timeline befinden, zu überschreiben und ohne vor 
dem Bearbeiten der Automation eine Selektion 
definieren zu müssen.

 Die Write Automation to Punch Point-Option 
ermöglicht es Ihnen, einen Automationswert auf 
einer Spur zurück aufzufüllen, nachdem Sie 
während eines Automationsdurchgangs den 
richtigen Pegel oder die richtige Einstellung 
gefunden haben. Dabei müssen Sie nicht 
zurückgehen und den Durchgang wiederholen.

Write On Stop-Schaltflächen im Automation-Fenster
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Wie die Standardbefehle Write Automation to 

Start, Write Automation to End und Write 

Automation to All funktionieren auch die Befehle 
Write Automation to Next Breakpoint und Write 

Automation to Punch Point nicht, wenn der 
Transport in Pro Tools angehalten ist. Sie haben 
lediglich eine Auswirkung auf die Automation der 
Parameter, die gegenwärtig für die Aufzeichnung 
aktiviert sind und Automationsdaten aufzeichnen. 

Optional können die Befehle Write Automation to 

Next Breakpoint und Write Automation to Punch 

Point so konfiguriert werden, dass sie nach einem 
gültigen Automationsdurchgang automatisch 
angewendet werden. Siehe „Schreiben von 
Automation bis zum nächsten Breakpoint oder 
Punch-Punkt im On Stop-Modus“ auf Seite 1119.

So schreiben Sie aktuelle Automationswerte bis 
zum nächsten Breakpoint:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp für 
die Aufzeichnung aktiviert (write-enabled) ist.

3 Klicken Sie in eine Spur, um einen 
Einfügepunkt zu definieren.

4 Starten Sie die Wiedergabe.

5 Vergewissern Sie sich im Latch-, Touch- oder 
Touch/Latch-Modus, dass Sie aktiv auf der 
entsprechenden Spur schreiben.

6 Wenn Sie eine Stelle auf der Spur erreichen, an 
der Sie die aktuellen Einstellungen anwenden 
möchten, klicken Sie auf die Write Automation 
to Next Breakpoint-Schaltfläche.

7 Halten Sie die Wiedergabe an. 

Die aktuellen Werte aller an diesem Punkt 
aufgezeichneten Parameter werden bis zum 
nächsten Breakpoint geschrieben.

Bei der MIDI-Automation gelten Write To-
Befehle nur für MIDI Volume, MIDI Pan und 
MIDI Mute. Andere MIDI-Parameter können 
die Write To-Befehle nicht verwenden.

Die Write Automation to Next Breakpoint- 
und Write Automation to Punch Point-
Befehle haben die gleichen Anforderungen 
wie die Write Automation to Start-, End- und 
All-Befehle. Siehe „Schreiben von 
Automation bis zum Anfang, Ende oder für 
eine gesamte Spur oder eine Selektion“ auf 
Seite 1114.

Write To Next Breakpoint-Schaltflächen im 
Automation-Fenster

Das Schreiben von Automation zum 
nächsten Breakpoint bleibt nach einem 
gültigen Automationsdurchgang aktiviert. 
Im Gegensatz zu den Standardbefehlen zum 
Schreiben von Automation kann diese 
Funktion nicht so konfiguriert werden, dass 
sie nach einem Automationsdurchgang 
deaktiviert wird.

Write to Next Breakpoint

Write to Next Breakpoint 
on Stop
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So schreiben Sie aktuelle Automationswerte 
zurück zum Automations-Punch-Punkt:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp für 
die Aufzeichnung aktiviert (write-enabled) ist. 

3 Klicken Sie in eine Spur, um einen 
Einfügepunkt zu definieren.

4 Starten Sie die Wiedergabe.

5 Vergewissern Sie sich im Latch-, Touch- oder 
Touch/Latch-Modus, dass Sie aktiv auf der 
entsprechenden Spur schreiben.

6 Wenn Sie eine Stelle auf der Spur erreichen, an 
der Sie die aktuellen Einstellungen anwenden 
möchten, klicken Sie auf die Write Automation 
to Punch Point-Schaltfläche.

Die aktuellen Werte aller für die Aufzeichnung 
aktivierten Parameter werden bis zu dem Punkt 
zurück geschrieben, an dem der erste Parameter 
die Automationsaufzeichnung begonnen hat.

„Write To Next Breakpoint“ oder 
„Write To Next Punch Point“ und 
Trim-Modus
Im Trim-Modus ist es auch möglich, Trim-Werte 
für Spurlautstärke- und Send-Pegel bis zum 
nächsten aufgezeichneten Breakpoint oder zum 
Automations-Punch-In-Punkt zurück zu 
schreiben. 

So schreiben Sie aktuelle Trim-Werte bis zum 
nächsten Breakpoint oder zum Punch-Punkt:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp 
(Spurlautstärke oder Send-Pegel) für die 
Aufzeichnung aktiviert ist (write-enabled).

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor und wählen Sie 
Trim. Die Fader für Spurlautstärke und Send-
Pegel werden nun gelb dargestellt.

4 Klicken Sie in eine Spur, um einen 
Einfügepunkt zu definieren.

5 Starten Sie die Wiedergabe. 

6 Wenn Sie eine Stelle auf der Spur erreichen, 
an der Sie die aktuellen Trim-Werte anwenden 
möchten, klicken Sie im Automation-Fenster 
auf die Write Automation to Next Breakpoint-
Schaltfläche.

So schreiben Sie aktuelle Trim-Werte bis zum 
Punch-Punkt:

1 Wählen Sie Window > Automation.

2 Stellen Sie sicher, dass der Automationstyp 
(Spurlautstärke oder Send-Pegel) für die 
Aufzeichnung aktiviert ist (write-enabled).

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor und wählen Sie 
„Trim“. Die Fader für Spurlautstärke und Send-
Pegel werden nun gelb dargestellt.

Write To Punch Point-Schaltflächen im Automation-
Fenster

Schreiben bis zum
Punch-Punkt

Write to Punch
Point on Stop
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4 Klicken Sie in eine Spur, um einen 
Einfügepunkt zu definieren.

5 Starten Sie die Wiedergabe. 

6 Wenn Sie eine Stelle auf der Spur erreichen, an 
der Sie die aktuellen Trim-Werte anwenden 
möchten, klicken Sie im Automation-Fenster 
auf die Write Automation to Next Punch Point-
Schaltfläche.

Schreiben von Automation bis 
zum nächsten Breakpoint oder 
Punch-Punkt im On Stop-Modus
Das Automation-Fenster enthält eine Option zum 
automatischen Schreiben der Automation bis zum 
nächsten Breakpoint oder bis zum Punch-Punkt im 
On Stop-Modus.

So konfigurieren Sie das Schreiben von Automation 
zum nächsten Breakpoint im On Stop-Modus:

1 Wählen Sie Window > Automation.

2 Klicken Sie auf die Write Automation to Next 
Breakpoint on Stop-Schaltfläche oder auf die 
Write Automation to Punch Point-Schaltfläche. 

Wenn diese Option aktiviert ist, werden nach 
einem gültigen Automationsdurchgang 
automatisch Automationsdaten vorwärts bis zum 
nächsten Breakpoint aufgezeichnet.

So konfigurieren Sie das Schreiben von Automation 
bis zum nächsten Punch-Punkt im On Stop-Modus:

1 Wählen Sie Window > Automation.

2 Klicken Sie auf die Write Automation to Punch 
Point on Stop-Schaltfläche. 

Wenn diese Option aktiviert ist, werden nach einem 
gültigen Automationsdurchgang Automationsdaten 
bis zum nächsten Automations-Punch-In-Punkt 
automatisch zurück aufgezeichnet.

Richtlinien für „Write To“-
Befehle
(Nur Pro Tools HD)

Verwenden von „Write To“-
Befehlen während der 
Wiedergabe
Sie können jeden der Write Automation To-Befehle 
verwenden, ohne den Transport in Pro Tools 
anzuhalten. In unterstützten Bedienoberflächen 
blinkt die entsprechende Write To-Schaltfläche, 
bis Sie den Transport anhalten.

Während der Transport in Pro Tools läuft, wirkt 
sich die Ausgabe von Write Automation To-
Befehlen in folgender Weise auf die 
Automationsaufzeichnung aus:

• Write to Start/Selection Start: Bei derzeit 
aufgezeichneten Parametern wird die 
Automationsaufzeichnung fortgesetzt.

• Write to All/Selection: Bei derzeit 
augefzeichneten Parametern (ausgenommen 
Parameter im Write-Modus) wird die 
Automationsaufzeichnung nicht fortgesetzt 
(Punch-Out).

• Write to End/Selection End: Bei derzeit 
augefzeichneten Parametern (ausgenommen 
Parameter im Write-Modus) wird die 
Automationsaufzeichnung nicht fortgesetzt 
(Punch-Out).

Das Schreiben von Automation zum nächsten 
Breakpoint bleibt nach einem gültigen 
Automationsdurchgang aktiviert. Im 
Gegensatz zu den Standardbefehlen zum 
Schreiben von Automation kann diese 
Funktion nicht so konfiguriert werden, dass 
sie nach einem Automationsdurchgang 
deaktiviert wird.
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• Write to Next Breakpoint: Bei derzeit 
augefzeichneten Parametern (ausgenommen 
Parameter im Write-Modus) wird die 
Automationsaufzeichnung nicht fortgesetzt 
(Punch-Out).

• Write to Punch Point: Bei derzeit 
aufgezeichneten Parametern wird die 
Automationsaufzeichnung fortgesetzt.

Anwenden von „Write To“-
Befehlen auf ausgewählte Spuren
Die Write Automation To-Befehle gelten 
normalerweise für alle Spuren, die gerade 
Automation aufzeichnen. Es ist möglich, diese 
Befehle nur auf ausgewählte Spuren anzuwenden. 

So wenden Sie einen der „Write Automation To“-
Befehle auf die gerade ausgewählten Spuren an:

1 Wählen Sie die Spuren aus, auf die Sie die Write 

To-Befehle anwenden möchten.

2 Klicken Sie bei gedrückter Alt- und 
Umschalttaste (Windows) bzw. Wahl- und 
Umschalttaste (Mac) auf die entsprechende 
Write Automation To-Schaltfläche.

Unterdrücken von Warnungen 
bei Verwendung von „Write To“-
Befehlen
Wenn Sie einen der Write Automation To-Befehle 
(ausgenommen „Write to Next Breakpoint“) 
ausführen, wird in Pro Tools ein Dialogfeld mit 
einer Warnung geöffnet, die informiert, dass 
Automationswerte in der Session geändert werden. 
Sie können diese Warnungen unterdrücken. 

So unterdrücken Sie „Write To“-Warnungen:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing.

2 Wählen Sie unter „Automation“ die Suppress 

Automation “Write To” Warnings-Option. 

Überschreiben oder Erweitern 
der Mute-Automation 
(Nur Pro Tools HD)

Sie können in Pro Tools ein bestehendes 
Stummschaltungs-Event in Echtzeit überschreiben 
oder erweitern, ohne den aktuellen Mute-Status zu 
ändern.

Ein Stummschaltungs-Event kann überschrieben 
werden, wenn der Automationsdurchgang vor dem 
ersten Stummschaltungs-Event beginnt und nach 
dem zweiten Event endet. In diesem Fall wird der 
aktuelle Status der Stummschaltung (ein bzw. aus) 
beibehalten.

Bei der MIDI-Automation gelten Write To-
Befehle nur für MIDI Volume, MIDI Pan und 
MIDI Mute. MIDI-Parameter können die 
Write To-Befehle nicht verwenden.

Überschreiben eines Stummschaltungsautomations-
Events

Ursprüngliche Stummschaltungsautomation 
(aus, ein, aus)

Stummschaltungs-Event (ein) wird überschrieben
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Ein Stummschaltungs-Event kann erweitert 
werden, wenn der Automationsdurchgang vor dem 
ersten Stummschaltungs-Event (ein bzw. aus) 
beginnt und vor Ende des zweiten Event endet.

Der Mute Overwrite/Extend-Befehl wird wie folgt 
im Touch- und Latch-Modus unterstützt:

Touch-Modus. – schreibt den aktuellen Status so 
lange, wie die Mute-Schaltfläche gedrückt 
gehalten wird.

Latch-Modus. – schreibt den aktuellen Status, bis 
Sie anhalten oder mit AutoMatch eine 
Ausblendung ausführen.

So überschreiben Sie einen Mute-Status auf einer 
oder mehreren Spuren:

1 Wählen Sie Window > Automation. 

2 Stellen Sie sicher, dass die Stummschaltung für 
die Aufzeichnung aktiviert (write-enabled) ist.

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor der Spur, auf der 
Sie den Stummschaltungsstatus überschreiben 
möchten, und stellen Sie den Automationsmodus 
auf Touch- oder Latch-Modus.

4 Klicken Sie in jeder Spur, die Sie 
automatisieren möchten, auf den Track View-
Selektor und wählen Sie „Mute“.

5 Platzieren Sie den Cursor vor dem Anfang eines 
Stummschaltungs-Events, das Sie 
überschreiben möchten.

Erweitern eines Stummschaltungsautomations-Events

Ursprüngliche Stummschaltungsautomation 
(aus, ein, aus)

Erweitertes Stummschaltungs-Event (aus) (bis zum 
Ende des Automatisierungsdurchgangs)

Mute Enable-Schaltfläche im Automation-Fenster

Setzen Sie alle betroffenen Spuren auf 
denselben Automationsmodus, um den Mute-
Status auf mehreren Spuren zu überschreiben.

Platzieren des Cursors vor dem Beginn eines 
Stummschaltungs-Events
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6 Starten Sie die Wiedergabe.

7 Drücken Sie vor dem Anfang des 
Stummschaltungs-Events, das Sie 
überschreiben möchten, die Strg- (Windows) 
bzw. Befehlstaste (Mac) und die Mute-
Schaltfläche.

8 Lassen Sie nach Ende des zweiten 
Stummschaltungs-Events die Taste und die 
Mute-Schaltfläche los.

9 Wenn Sie mit dem Automationsdurchgang 
fertig sind, halten Sie die Wiedergabe an.

So erweitern Sie einen Mute-Status auf einer Spur:

1 Wählen Sie Window > Automation. 

2 Stellen Sie sicher, dass die Stummschaltung für 
die Aufzeichnung aktiviert (write-enabled) ist.

3 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor der Spur, die Sie 
automatisieren möchten, und wählen Sie den 
Touch- oder Latch-Modus.

4 Klicken Sie in jeder Spur, die Sie 
automatisieren möchten, auf den Track View-
Selektor und wählen Sie „Mute“.

5 Platzieren Sie den Cursor vor dem Anfang eines 
Stummschaltungs-Events, das Sie erweitern 
möchten.

6 Starten Sie die Wiedergabe.

7 Drücken Sie vor dem Anfang des 
Stummschaltungs-Events, das Sie erweitern 
möchten, die Strg- (Windows) bzw. 
Befehlstaste (Mac) und die Mute-Schaltfläche.

Drücken Sie zum Überschreiben des Mute-
Status auf mehreren Spuren Alt + Strg 
(Windows) bzw. Wahl + Befehl (Mac) sowie 
Sie die Mute-Taste auf einer der zu 
automatisierenden Spuren.

Im Touch-Modus müssen Sie die Mute-
Schaltfläche für die Dauer des 
Schreibvorgangs gedrückt halten.

Anhalten des Automationsdurchgangs nach dem 
Ende eines Stummschaltungs-Events

Beispiel eines überschriebenen Mute-Status

Überschriebener Mute-Status 

Setzen Sie alle betroffenen Spuren auf 
denselben Automationsmodus, um den 
Stummschaltungsstatus auf mehreren Spuren 
zu erweitern.

Platzieren des Cursors vor dem Beginn eines 
Stummschaltungs-Events

Drücken Sie zum Erweitern des Mute-Status 
auf mehreren Spuren Alt + Strg (Windows) 
bzw. Wahl + Befehl (Mac) sowie die Mute-
Taste auf der Spur.
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8 Lassen Sie vor Ende des zweiten 
Stummschaltungs-Events die Taste und die 
Mute-Schaltfläche los.

9 Wenn Sie mit dem Automationsdurchgang 
fertig sind, klicken Sie auf „Stop“.

Erstellen von Snapshot-
Automation
(Nur Pro Tools HD)

Sie können in Pro Tools HD Automationsdatenwerte 
für mehrere Parameter im selben Schritt aufzeichnen. 
Zum Aufzeichnen von Snapshot-Automation haben 
Sie zwei Möglichkeiten:

Für eine Selektion. – die Automationsdaten 
werden in die Timeline-Selektion (und die Edit-
Selektion, sofern gekoppelt) geschrieben. Anker-
Breakpoints werden kurz vor und kurz nach der 
Selektion erzeugt, sodass Daten außerhalb der 
Selektion nicht beeinflusst werden.

An einer Cursor-Position. – die 
Automationsdaten werden an dem Einfügepunkt 
aufgezeichnet. Von diesem Punkt an steigt bzw. 
fällt der Automationswert stetig bis zum Erreichen 
des nächsten Breakpoint-Werts. Falls keine 
Breakpoints vorliegen, bleibt der neu 
aufgezeichnete Wert für den Rest der Session 
gleich.

Weitere Informationen zum Ausschneiden, 
Kopieren und Einfügen von Automationsdaten 
innerhalb einer Session finden Sie unter 
„Schreiben von Automation bis zum Anfang, Ende 
oder für eine gesamte Spur oder eine Selektion“ 
auf Seite 1114.

Wenn Sie über das nächste Stummschaltungs-
Event (ein bzw. aus) hinaus erweitern, wird 
das ganze Event geändert.

Anhalten der Automation vor dem Ende eines 
Stummschaltungs-Events

Beispiel eines erweiterten Mute-Status (bis zum Ende 
des Automationsdurchgangs)

Bei der MIDI-Automation gelten die Write 
To-, Trim To- und Glide To-Befehle nur für 
MIDI Volume, MIDI Pan und MIDI Mute. 
MIDI-Parameter können die Write To-
Befehle nicht verwenden.
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So zeichnen Sie Snapshot-Automation auf:

1 Im Automation-Fenster müssen die Parameter, 
die Sie editieren möchten, für die Aufzeichnung 
aktiviert sein (write-enabled). Deaktivieren Sie 
die Parameter, deren Automation Sie erhalten 
möchten.

2 Klicken Sie im Edit-Fenster auf den Track 
View-Selektor, um die gewünschten 
Automationsdaten anzuzeigen.

3 Schreiben Sie folgendermaßen einen 
Breakpoint in die Playlist, wenn derzeit keiner 
vorhanden ist:

• Platzieren Sie den Cursor in der Playlist (oder 
nehmen Sie eine Edit-Selektion vor) und drücken 
Sie dann Strg + Schrägstrich (/) (Windows) bzw. 
Befehl + Schrägstrich (/) (Mac).

• Wählen Sie das Grabber-Tool und klicken Sie an 
eine beliebige Stelle in der Playlist.

4 Sie haben folgende Möglichkeiten:

• Selektieren Sie den Bereich in der Playlist der 
Spur (oder in mehreren Spuren), in der Sie 
Automationsdaten aufzeichnen möchten. 

• Positionieren Sie den Cursor an einem Edit-
Einfügepunkt.

5 Stellen Sie die Parameter ein, die Sie 
automatisieren möchten. Sie können auch eine 
Plug-In-Voreinstellung ändern.

6 Wählen Sie Edit > Automation. Anschließend 
haben Sie zwei Möglichkeiten:

• Um den aktuellen Wert ausschließlich für den 
gegenwärtig angezeigten 
Automationsparameter zu schreiben, wählen Sie 
Write to Current.

• Um die aktuellen Einstellungen für alle 
Automationsparameter aufzuzeichnen, die im 
Automation-Fenster aktiviert wurden, wählen 
Sie Write to All Enabled.

Hinzufügen von Snapshot-
Automation zu leeren 
Automations-Playlists
Wenn Sie einen der Write Automation-Befehle auf 
eine Automations-Playlist anwenden, die noch 
keine Automationsdaten enthält, wird der 
gewählte Wert für die gesamte Playlist und nicht 
nur für den selektierten Bereich aufgezeichnet.

Dies liegt daran, dass eine Playlist ohne 
Automationsdaten nur einen einzelnen 
Automations-Breakpoint enthält, der der aktuellen 
Position des Steuerelements für den Parameter 
entspricht. Die Position des Breakpoints wird 
aktualisiert, sobald sich der Parameterwert ändert. 

Damit der Write Automation-Befehl den gewählten 
Automationswert nicht für die gesamte Playlist 
schreibt, können Sie Folgendes tun:

• Verankern Sie die Automationsdaten, indem Sie 
den Cursor am Ende der Session (oder einem 
anderen Endpunkt) positionieren und die Write 

to Current-Option wählen.

• Klicken Sie mit einem beliebigen Grabber-Tool 
auf beide Seiten der Selektion.

So können die Daten mit dem Write Automation-
Befehl nur im selektierten Bereich aufgezeichnet 
werden.
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Überschreiben vorhandener 
Automationsdaten mit 
Snapshot-Automation
Wenn Sie den Playback-Cursor bewegen, werden 
die automatisierten Steuerelemente in Pro Tools 
aktualisiert, sodass die Automationsdaten, die sich 
bereits auf der Spur befinden, widergespiegelt 
werden. Um die Einstellungen für einen Snapshot 
zu erhalten, können Sie die Automationsparameter 
außer Kraft setzen, damit sie nicht aktualisiert 
werden.

So überschreiben Sie bestehende Daten mit 
Snapshot-Automation:

1 Im Automation-Fenster müssen die 
Automationsparameter, die Sie editieren 
möchten, für die Aufzeichnung aktiviert sein 
(write-enabled). Deaktivieren Sie die 
Parameter, deren Automation Sie erhalten 
möchten.

2 Stellen Sie die Steuerelemente für die zu 
automatisierenden Parameter ein.

3 Klicken Sie auf den Automation Mode-Selektor 
und wählen Sie den Off-Modus für die Spuren, 
auf denen Sie die Automatisierung anwenden 
möchten.

4 Selektieren Sie mit dem Selector-Tool den 
Bereich, auf den Sie die Automation anwenden 
möchten.

5 Wählen Sie Edit > Automation und aktivieren Sie 
im Untermenü eine der folgenden Optionen:

• Um den aktuellen Wert ausschließlich für den 
gegenwärtig im Edit-Fenster angezeigten 
Automationsparameter zu schreiben, wählen Sie 
Write to Current.

• Um die aktuellen Einstellungen für alle 
Automationsparameter aufzuzeichnen, die im 
Automation-Fenster aktiviert wurden, wählen 
Sie Write to All Enabled.

6 Klicken Sie auf den Automation Mode-Selektor 
und wählen Sie den Read-Modus für die 
Spuren, die mit Automation wiedergegeben 
werden sollen.

Erfassen von Automationsdaten 
und Anwenden an anderer Stelle
Die Write Automation-Befehle können auch 
verwendet werden, um Automationszustände an 
bestimmten Positionen in einer Spur zu erfassen und 
sie auf andere Stellen in der Spur anzuwenden.

So erfassen Sie Automationsdaten und wenden 
sie an anderer Stelle an:

1 Im Automation-Fenster müssen die 
Automationsparameter, die Sie editieren 
möchten, für die Aufzeichnung aktiviert sein 
(write-enabled). Deaktivieren Sie die 
Parameter, deren Automation Sie erhalten 
möchten.

2 Klicken Sie auf den Automation Mode-Selektor 
und wählen Sie den Read-Modus für die 
Spuren, auf denen Sie Automation erfassen 
möchten.

3 Stellen Sie sicher, dass Options > Link Timeline 
and Edit Selection ausgewählt ist.

4 Markieren Sie mit dem Selector-Tool die 
Position, an der Sie die Automation erfassen 
möchten. Alle automatisierten Steuerelemente 
werden aktualisiert und spiegeln die 
Automation an dieser Stelle wider. (Wenn Sie 
einen Bereich selektieren, werden die 
Steuerelemente aktualisiert, sodass die 
Automation am Anfang der Selektion 
widergespiegelt wird.)

5 Klicken Sie in jeder Spur, auf die Sie die 
erfasste Automation anwenden möchten, auf 
den Automation Mode-Selektor und setzen Sie 
den Automationsmodus auf Off.

6 Markieren Sie mit dem Selector-Tool die 
Position, auf die Sie die Automation anwenden 
möchten.

7 Aktivieren Sie die zuvor ausgesetzten 
Automationsparameter.
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8 Wählen Sie Edit > Automation und aktivieren 
Sie im Untermenü eine der folgenden Optionen:

• Um den aktuellen Wert ausschließlich für den 
gegenwärtig im Edit-Fenster angezeigten 
Automationsparameter zu schreiben, wählen Sie 
Write to Current.

• Um die aktuellen Einstellungen für alle 
Automationsparameter aufzuzeichnen, die im 
Automation Enable-Fenster aktiviert wurden, 
wählen Sie Write to All Enabled.

9 Klicken Sie auf den Automation Mode-Selektor 
und wählen Sie den Read-Modus für die 
Spuren, die mit Automation wiedergegeben 
werden sollen.

Snapshot-Automation und 
Trimmen von Automationsdaten
Dank des Trim Automation-Befehls ist es in 
Pro Tools möglich, Trim-Werte als Snapshots zu 
benutzen und die relativen Änderungen 
(Deltawerte) auf die selektierte Automation 
anzuwenden. Dieser Befehl funktioniert etwa auf 
die gleiche Weise wie der Write Automation-
Befehl, allerdings werden hier statt absoluter 
Werte Deltawerte auf die Automationsdaten 
angewendet. 

Sie können Trimmwerte verwenden, wenn Sie 
Snapshot-Automation für einen beliebigen 
automatisierbaren Parameter schreiben.

So erzeugen Sie einen Snapshot mit den relativen 
Änderungen an Automationsdaten:

1 Im Automation-Fenster müssen die 
Automationsparameter, die Sie editieren 
möchten, für die Aufzeichnung aktiviert sein 
(write-enabled). Deaktivieren Sie die 
Parameter, deren Automation Sie erhalten 
möchten.

2 Selektieren Sie den gewünschten Bereich der 
Spur. Alle automatisierten Parameter werden 
aktualisiert, sodass sie die Automation am 
Anfang der Selektion widerspiegeln.

3 Verschieben Sie die Regler für den Parameter 
um den Wert, um den Sie die Daten ändern 
möchten. 

4 Wählen Sie Edit > Automation. Anschließend 
haben Sie zwei Möglichkeiten:

• Um den aktuellen Deltawert ausschließlich für 
den gegenwärtig angezeigten 
Automationsparameter aufzuzeichnen, wählen 
Sie Trim to Current.

• Um den aktuellen Deltawert für alle 
Automationsparameter aufzuzeichnen, die im 
Automation-Fenster aktiviert wurden, wählen 
Sie Trim to All Enabled.
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Vorhören der Automation
(Nur Pro Tools HD)

Im Automation Preview-Modus können Sie 
Änderungen an einer Mischung abhören und mit 
vorhandenen Automationswerten vergleichen, 
ohne sie in die Automations-Playlist zu 
übernehmen.

Wenn Sie Pro Tools in den Automation Preview-
Modus versetzen, können Sie Werte für 
automationsfähige Parameter auf jeder Spur, die 
sich in einem beschreibbaren Automationsmodus 
befindet, vorhören. 

Wenn Sie im Automation Preview-Modus ein 
Steuerelement berühren oder verschieben, wird es 
isoliert und aus der zugehörigen Automations-
Playlist ausgekoppelt. Das Steuerelement 
unterbricht das Lesen oder Schreiben von 
Automation und ermöglicht Ihnen so das 
ungehinderte Abhören von Änderungen.

Sobald Sie einen Pegel oder Zustand gefunden 
haben, den Sie verwenden möchten, können 
Sie den abgehörten Wert in die Automations-
Playlist für die isolierten Steuerelemente 
übernehmen (Punch). 

 Wenn Sie während der Wiedergabe einen 
Punch-Vorgang durchführen, wird der 
Automationsmodus auf „Latch“ gesetzt und die 
Aufzeichnung beginnt beim Vorhörwert. 

 Führen Sie einen Punch-Vorgang durch, 
während der Transport angehalten ist, wird der 
Automationsmodus auf „Latch“ gesetzt und das 
Steuerelement wird am Vorhörwert vorbereitet.

Vorhören neuer 
Automationswerte

So können Sie einen neuen Automationswert für 
ein Steuerelement vorhören:

1 Stellen Sie sicher, dass die Spur, auf der Sie den 
Wert vorhören möchten, für die Automation 
aktiviert ist (Touch-, Latch-, Touch/Latch-
Modus oder entsprechende Trim-Modi). 

2 Stellen Sie sicher, dass der gewünschte 
Automationstyp im Automation-Fenster 
aktiviert ist (Volume, Pan, Mute, Send Level, 
Send Pan, Send Mute oder Plug-In). 

3 Klicken Sie auf die Preview-Schaltfläche im 
Automation-Fenster. Die Schaltfläche leuchtet 
grün, um anzugeben, dass der Vorhörmodus 
aktiv ist.

Es ist nicht erforderlich, die Allow Latch 
Prime in Stop-Voreinstellung für das 
Vorhören zu aktivieren, um ein Steuerelement 
in den Latch Prime-Modus zu versetzen.

Preview-Steuerelemente im Automation-Fenster
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4 Zum Isolieren eines Steuerelements berühren 
oder bewegen Sie ein für die Automation 
aktiviertes Steuerelement. Sie können 
Steuerelemente während der Wiedergabe oder 
bei angehaltenem Transport isolieren. 

Die Automation Mode-Anzeige auf der Spur 
leuchtet grün, um anzugeben, dass mindestens eins 
ihrer Steuerelemente isoliert ist; die Punch 
Preview-Schaltfläche im Automation-Fenster 
leuchtet, um anzuzeigen, dass ein Vorhörwert für 
einen Punch-Vorgang verfügbar ist.

5 Starten Sie die Wiedergabe und passen Sie das 
isolierte Steuerelement an, um die Änderungen 
abzuhören.

Herausnehmen von 
Steuerelementen aus dem 
Isolationszustand
Sie können Steuerelemente aus dem 
Isolationszustand herausnehmen, ohne den 
Vorhörmodus zu verlassen.

Führen Sie einen der folgenden Schritte durch, um 
alle Steuerelemente auf einer Spur aus dem 
Isolationszustand herauszunehmen:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf den 
Automation Mode-Selektor auf der Spur.

 Ändern Sie den Automationsmodus der Spur zu 
„Read“ oder „Off“. 

So nehmen Sie alle Steuerelemente eines 
Automationstyps aus dem Isolationszustand 
heraus:

 Deaktivieren Sie im Automation-Fenster den 
Automationstyp.

Isolieren mehrerer 
Steuerelemente
In manchen Fällen kann es hilfreich sein, mehrere 
Steuerelemente gleichzeitig zu isolieren, 
beispielsweise beim Starten einer neuen Mischung.

So isolieren Sie alle derzeit für die Aufzeichnung 
aktivierten Steuerelemente:

 Klicken Sie bei gedrückter Alt- (Windows) bzw. 
Wahltaste (Mac) auf die Preview-Schaltfläche.

So isolieren Sie alle für die Aufzeichnung aktivierten 
Steuerelemente auf allen ausgewählte Spuren:

 Klicken Sie bei gedrückter Alt- und Umschalttaste 
(Windows) bzw. Wahl- und Umschalttaste (Mac) 
auf die Preview-Schaltfläche.

Aussetzen des Vorhörmodus
Sie können den Vorhörmodus vorübergehend 
aussetzen, damit Sie zwischen Vorhörwerten 
und vorhandener Automation hin- und 
herwechseln können. 

So setzen Sie den Vorhörmodus aus:

 Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac) auf die 
Preview-Schaltfläche.

Schreiben von Vorhörwerten mit 
der Punch-Funktion
Nachdem Sie ein Steuerelement isoliert und einen 
neuen Wert abgehört haben, können Sie diesen Wert 
in die Automations-Playlist schreiben (Punch). 

So schreiben Sie einen Vorhörwert mit der Punch-
Funktion in die Automations-Playlist:

 Klicken Sie auf die leuchtende Punch Preview-
Schaltfläche.
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Vorhörmodus und „Write To“-
Befehle
Die Write Automation To-Befehle verhalten sich 
im Vorhörmodus folgendermaßen:

Vor dem Schreiben von Vorhörwerten mit der 
Punch-Funktion. – die Write Automation To-
Befehle (ausgenommen Write to Next Breakpoint) 
können verwendet werden, um Vorhörwerte zu 
erweitern. Der Write Automation To-Befehl gilt nur 
für isolierte Steuerelemente. Pro Tools bleibt im 
Vorhörmodus.

Nach dem Schreiben von Vorhörwerten mit der 
Punch-Funktion. – die Write Automation To-
Befehle (ausgenommen Write to Next Breakpoint) 
können verwendet werden, um den Punch-Wert 
auf die gleiche Weise wie bei anderer Automation 
zu erweitern. 

Erfassen von Automation
(Nur Pro Tools HD)

Sie können aktuelle Automationswerte an einer 
Position in einer Session erfassen und mit den 
Capture- und Punch Capture-Befehlen schnell an 
einer anderen Position anwenden. Mit dem Befehl 
Capture wird der Wert aller Steuerelemente, die 
gerade Automation aufzeichnen, vorübergehend 
gespeichert. Der Befehl Punch Capture schreibt 
diese gespeicherten Werte in alle aktivierten 
Automationstypen.

 ICON-Systeme ermöglichen die Erfassung von 
max. 48 verschiedenen Werten oder Snapshots. 

 In allen anderen Systemen ist die Erfassung 
eines einzelnen Wertes möglich.

Erfassen von 
Automationswerten
Sie können die aktuellen Automationswerte von 
aktiv aufzeichnenden Parametern erfassen. 

So erfassen Sie Automationswerte:

1 Stellen Sie sicher, dass alle Spuren, deren 
Automationswerte Sie erfassen möchten, für 
die Aufzeichnung aktiviert sind (Write, Touch, 
Latch, Touch/Latch oder Latch).

2 Stellen Sie sicher, dass die Automationstypen, 
die Sie erfassen möchten, im Automation-
Fenster aktiviert sind (Volume, Pan, Mute, Send 
Level, Send Pan, Send Mute oder Plug-In).

3 Starten Sie die Wiedergabe. Wenn Sie eine 
Position erreichen, an der Sie die aktuellen 
Automationszustände erfassen möchten, 
klicken Sie im Automation-Fenster auf die 
Schaltfläche Capture.

Die Punch Capture-Schaltfläche im Automation-
Fenster leuchtet, um anzugeben, dass ein erfasster 
Wert für die Punch-Funktion verfügbar ist.

Capture-Steuerelemente im Automation-Fenster
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Schreiben von erfassten 
Automationswerten mit der 
Punch-Funktion
Nach der Erfassung von Automationswerten 
können Sie an eine andere Stelle auf der Spur 
geschrieben werden (Punch). Spuren mit der 
Einstellung Read oder Off bleiben davon 
unberührt.

 Wenn Sie die Punch-Funktion während der 
Wiedergabe ausführen, wird der 
Automationsmodus jeder Spur mit der Einstellung 
Touch auf Latch gesetzt und die Aufzeichnung 
beginnt bei dem erfassten Wert.

 Wenn Sie die Punch-Funktion ausführen, 
während der Transport angehalten ist, wird der 
Automationsmodus jeder Spur mit der Einstellung 
Touch auf Latch gesetzt und das Steuerelement wird 
an dem erfassten Wert vorbereitet.

So schreiben Sie erfasste Automationswerte mit 
der Punch-Funktion:

1 Gehen Sie zu einer Position, an der Sie die 
erfassten Automationszustände anwenden 
möchten. Sie können dies während der 
Wiedergabe oder bei angehaltenem Transport 
ausführen.

2 Klicken Sie im Automation-Fenster auf die 
Punch Capture-Schaltfläche, um die erfassten 
Automationszustände anzuwenden. Die 
erfassten Zustände werden auf alle 
Automationstypen angewendet, die gerade im 
Automation-Fenster aktiviert sind.

Erfassen von 
Automationswerten für alle 
Steuerelemente
Sie können den Status aller automatisierbaren 
Steuerelemente (außer auf Spuren, deren 
Automationsmodus Off lautet) in einer Session 
erfassen, wobei es keine Rolle spielt, ob diese 
gerade Automation aufzeichnen.

So erfassen Sie die Automationswerte aller 
Steuerelemente:

 Wenn Sie eine Position erreichen, an der Sie die 
aktuellen Automationszustände erfassen 
möchten, klicken Sie bei gedrückter Alt-Taste 
(Windows) bzw. Wahltaste (Mac) auf die 
Capture-Schaltfläche.

So erfassen Sie die Automationswerte aller 
Steuerelemente nur auf ausgewählten Spuren:

 Wenn Sie eine Position erreichen, an der Sie die 
aktuellen Automationszustände erfassen 
möchten, klicken Sie bei gedrückter Alt- und 
Umschalttaste (Windows) bzw. Wahl- und 
Umschalttaste (Mac) auf die Capture-
Schaltfläche.

Schreiben von 
Automationswerten für alle 
Steuerelemente mit der Punch-
Funktion
Sie können alle erfassten Automationswerte mit der 
Punch-Funktion an eine andere Position auf ihren 
jeweiligen Spuren schreiben (ausgenommen die 
Spuren mit dem Automationsmodus Off). 

So schreiben Sie die Automationswerte aller 
Steuerelemente mit der Punch-Funktion:

 Wenn Sie eine Position erreichen, an der Sie die 
erfassten Automationszustände anwenden 
möchten, klicken Sie bei gedrückter Alt- 
(Windows) bzw. Wahltaste (Mac) auf die Punch 
Capture-Schaltfläche. Spuren mit der 
Einstellung Read oder Touch werden auf Latch 
gesetzt. Spuren mit der Einstellung Off bleiben 
davon unberührt. 
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So schreiben Sie die Automationswerte aller 
Steuerelemente nur auf ausgewählten Spuren mit 
der Punch-Funktion:

 Wenn Sie eine Position erreichen, an der Sie die 
erfassten Automationszustände anwenden 
möchten, klicken Sie bei gedrückter Alt- und 
Umschalttaste (Windows) bzw. Wahl- und 
Umschalttaste (Mac) auf die Punch Capture-
Schaltfläche. Ausgewählte Spuren mit der 
Einstellung Read oder Touch werden auf Latch 
gesetzt. Ausgewählte Spuren mit der 
Einstellung Off bleiben davon unberührt. 

Erfassen und Trim-Modus
Die Befehle Capture und „Punch Capture“ 
funktionieren zusammen mit der Trim-Automation 
genauso wie bei der normalen Automation. 
Pro Tools speichert den Trim-Status bei der 
Erfassung. Wenn Sie versuchen, erfasste Trim-
Werte mit der Punch-Funktion zu schreiben, 
während Sie eine andere Automations-Playlist (nicht 
Trim) anzeigen, wendet Pro Tools automatisch die 
Werte auf die entsprechende Trim-Playlist an. 

Punch Capture- und „Write To“-
Befehle
Nach der Ausgabe eines Punch Capture-Befehls 
zeichnen die betroffenen Steuerelemente die 
Automation (im Latch-Modus) auf. Somit kann 
jeder der Write Automation To-Befehle verwendet 
werden, um den mit der Punch-Funktion 
geschriebenen Wert genau wie bei anderer 
Automation zu erweitern. 

Erfassen und Vorhörmodus

Laden erfasster Werte für das Vorhören

Sie können erfasste Automationswerte im 
Vorhörmodus abhören und ändern, bevor Sie 
die Werte mit der Punch-Funktion in die 
Automations-Playlist schreiben. 

So erfassen Sie einen Automationswert und 
verwenden ihn für das Vorhören:

1 Stellen Sie sicher, dass die Spur, auf der Sie den 
Wert vorhören möchten, für die Automation 
aktiviert ist (Touch-, Latch-, Touch/Latch-Modus 
oder entsprechende Trim-Modi).

2 Stellen Sie sicher, dass der gewünschte 
Automationstyp im Automation-Fenster 
aktiviert ist (Volume, Pan, Mute, Send Level, 
Send Pan, Send Mute oder Plug-In). 

3 Erfassen Sie einen Automationswert, den Sie an 
einer anderen Stelle auf einer Spur vorhören 
möchten. (Siehe „Erfassen von 
Automationswerten“ auf Seite 1129.)

4 Gehen Sie an eine Position, an der Sie die 
erfassten Automationszustände vorhören 
möchten, und klicken Sie im Automation-
Fenster auf die Preview-Schaltfläche. 

5 Klicken Sie auf die Punch Capture-Schaltfläche.

Die betroffenen Steuerelemente werden isoliert und 
auf die erfassten Werte aktualisiert. Die Punch 
Preview-Schaltfläche im Automation-Fenster 
leuchtet, um anzugeben, dass der Vorhörwert für 
die Punch-Funktion verfügbar ist.

6 Starten Sie die Wiedergabe und passen Sie das 
isolierte Steuerelement an, um die Änderungen 
abzuhören.

7 Wenn Sie bereit sind, den Vorhörwert mit der 
Punch-Funktion in die Automations-Playlist zu 
schreiben, klicken Sie auf die leuchtende Punch 
Preview-Schaltfläche.
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Erfassen von Werten im Vorhörmodus

Wenn Sie sich im Vorhörmodus befinden, können 
Sie die Werte isolierter Steuerelemente erfassen 
und sie an anderer Stelle auf der Spur anwenden. 
Durch Erfassung von Vorhörwerten können Sie die 
zugrunde liegende Automation an der Stelle, an der 
Sie erfassen, unverändert lassen.

Auf ICON-Systemen können Sie mit dem 
Vorhörmodus mehrere Snapshots erfassen, ohne 
die Automation zu verändern. 

So erfassen Sie einen Vorhörwert:

1 Aktivieren Sie den Vorhörmodus und isolieren 
Sie ein Steuerelement. (Siehe „Vorhören neuer 
Automationswerte“ auf Seite 1127). 

2 Starten Sie die Wiedergabe und passen Sie das 
isolierte Steuerelement an, um die Änderungen 
abzuhören.

3 Wenn Sie zur Erfassung des Vorhörwerts bereit 
sind, klicken Sie auf die Capture-Schaltfläche 
im Automation-Fenster.

Die Punch Capture-Schaltfläche im Automation-
Fenster leuchtet, um anzugeben, dass ein erfasster 
Wert für die Punch-Funktion verfügbar ist.

Automation von VCA Master-
Spuren
(Nur Pro Tools HD)

Sie können Änderungen an Steuerelementen für 
VCA-Master-Spuren (und den Steuerelementen 
für VCA-Slave-Spuren) automatisieren.

Anzeigen der Automation auf 
VCA Master-Spuren
Die folgenden Steuerelemente auf VCA Master-
Spuren können automatisiert werden und verfügen 
über separate Automations-Playlists:

• Volume

• Volume Trim

• Stummschaltung

Diese Automations-Playlists folgen dem gleichen 
Verhalten wie die Automations-Playlists auf 
anderen Spurarten. Weitere Informationen über 
die Volume-Trim-Automation finden Sie unter 
„Trimmen von Automationsdaten“ auf Seite 1112. 

Anzeigen der 
zusammengesetzten 
Automations-Playlist auf Slave-
Spuren
Wenn eine Spur ein VCA Slave ist, können Sie 
eine zusammengesetzte Automations-Playlist 
anzeigen, die den Anteil des VCA Masters an den 
Lautstärke- oder 
Stummschaltungsautomationsdaten auf der Slave-
Spur zeigt. Diese zusammengesetzte Playlist 
spiegelt die tatsächliche Position des Lautstärke-
Faders auf der Slave-Spur wider. Sie kann nicht 
direkt bearbeitet werden.
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So zeigen Sie die zusammengesetzte Playlist auf 
VCA Slave-Spuren an:

 Wählen Sie View > Automation > Composite 

Playlist. 

Ausschließen von VCA Slave-
Spuren von der VCA Master-
Automation
Wenn Sie Automation auf einer VCA Master-Spur 
aufzeichnen, werden die entsprechenden 
Bewegungen auf der zusammengesetzten 
Automations-Playlist jeder ihrer Slave-Spuren 
angezeigt. Wenn Sie eine Slave-Spur aus einem 
Automationsdurchgang ausschließen möchten, 
aktivieren Sie die Slave-Spur für die 
Automationsaufzeichnung.

So schließen Sie eine Slave-Spur aus dem VCA 
Master-Spur-Automationsdurchgang aus:

1 Aktivieren Sie die VCA Master-Spur für die 
Automationsaufzeichnung (Write-, Touch- oder 
Latch-Modus). 

2 Aktivieren Sie die Slave-Spur, die Sie 
ausschließen möchten, für die 
Automationsaufzeichnung (Write-Modus). 

3 Stellen Sie sicher, dass andere Slave-Spuren, 
die Sie in dem Durchgang berücksichtigen 
möchten, nicht für die 
Automationsaufzeichnung aktiviert sind. 

4 Starten Sie die Wiedergabe. 

5 Bewegen Sie den Fader auf der VCA Master-
Spur.

6 Halten Sie die Wiedergabe an. 

Die Automation wird so auf der ausgeschlossenen 
Slave-Spur aufgezeichnet, dass die Fader-
Bewegungen auf der VCA Master-Spur gelöscht 
werden; der Fader auf der ausgeschlossenen Slave-
Spur wird bei der anschließenden Wiedergabe 
nicht bewegt. 

Anzeigen der zusammengesetzten Automation auf 
einer VCA Slave-Spur

Zusammen-
gesetzte 
Playlist

Volume-
Automations-
Playlist

Automation für ausgeschlossene VCA Slave-Spur, 
VCA Master-Automation gelöscht

Eingeschlos-
sener Slave

Ausgeschlos-
sener Slave

VCA-Master
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Addieren von VCA-Automation
Es gibt verschiedene Möglichkeiten, um den Anteil 
der Lautstärke- und Stummschaltungsautomation 
einer ausgewählten VCA Master-Spur in die 
Automations-Playlists ihrer Slave-Spuren zu 
übernehmen bzw. damit zu addieren.

Zurücksetzen eines VCA-Masters
Sie können einen VCA Master verwenden, um 
gruppierte Automation aufzuzeichnen, die VCA-
Automation mit allen Slave-Spuren zu addieren 
und die Automation auf dem VCA Master zu 
löschen. Die Wiedergabe der addierten Spuren 
erfolgt genauso wie in der VCA-Gruppe.

So addieren Sie die Automation von einem VCA 
Master mit all seinen Slave-Spuren und behalten 
den VCA Master bei:

1 Wählen Sie die VCA Master-Spur aus, deren 
Automation Sie addieren möchten. 

2 Sie haben folgende Möglichkeiten:

• Wählen Sie Track > Coalesce VCA Master 
Automation. 

• Klicken Sie mit der rechten Maustaste auf den 
Namen der VCA Master-Spur und wählen Sie 
Coalesce VCA Master Automation.

Der zusammengesetzte Lautstärkepegel und der 
Mute-Status werden mit jeder der Slave-Spuren 
addiert. Der VCA Master-Lautstärke-Fader wird 
auf Null zurückgesetzt, die VCA-Stummschaltung 
wird aufgehoben und die Automation auf dem VCA 
Master wird bereinigt.

Löschen eines VCA-Masters
Sie können einen VCA Master vorübergehend 
verwenden, um gruppierte Automation 
aufzuzeichnen, und dann die VCA-Automation mit 
allen Slave-Spuren addieren, indem Sie den VCA 
Master löschen. Die Wiedergabe der addierten 
Spuren erfolgt genauso wie in der VCA-Gruppe.

So addieren Sie die Automation von einem VCA 
Master mit all seinen Slave-Spuren und löschen 
die VCA Master-Spur:

1 Wählen Sie die VCA Master-Spur aus, deren 
Automation Sie addieren möchten.

2 Wählen Sie Track > Delete.

Der zusammengesetzte Lautstärkepegel und der 
Mute-Status werden auf jeder der Slave-Spuren 
übernommen.

Entfernen einer Slave-Spur aus 
einer VCA-Gruppe
Sie können eine einzelne Slave-Spur aus einer VCA-
Gruppe entfernen, wobei die VCA-Automation auf 
dieser Spur übernommen wird und der VCA Master 
und die anderen Slave-Spuren unberührt bleiben. 
Die Wiedergabe der addierten Slave-Spur erfolgt 
genauso wie in der VCA-Gruppe.

So addieren Sie die Automation von einer VCA 
Master-Spur mit einer einzelnen Slave-Spur:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie Modify Groups aus dem Menü der 
Groups-Liste. 

• Klicken Sie auf die Group ID-Anzeige auf der 
Spur und wählen Sie Modify. 

• Klicken Sie mit der rechten Maustaste auf den 
Gruppennamen in der Groups-Liste und wählen 
Sie Modify.

2 Wählen Sie im Groups-Dialogfeld die VCA-
gesteuerte Gruppe aus, die die Slave-Spur enthält.

3 Klicken Sie im Groups-Dialogfeld auf „Tracks“ 
und entfernen Sie die Slave-Spur aus der Gruppe.

4 Klicken Sie auf OK.

Die Slave-Spur wird aus der VCA-Gruppe entfernt 
und der zusammengesetzte Lautstärkepegel und der 
Mute-Status werden mit der Spur addiert. 

Diese Aktion kann nicht rückgängig gemacht 
werden.
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Duplizieren einer Slave-Spur
Wenn Sie eine Slave-Spur duplizieren, ohne ihre 
Gruppenzuweisungen zu duplizieren, wird die 
VCA-Automation mit der duplizierten Spur 
addiert. Die Wiedergabe des addierten Duplikats 
erfolgt genauso wie in der VCA-Gruppe. 

So addieren Sie die Automation von einem VCA 
Master mit einer einzelnen Slave-Spur, indem Sie 
die Spur duplizieren:

1 Wählen Sie die Slave-Spur aus, deren 
Automation Sie addieren möchten. 

2 Wählen Sie Track > Duplicate.

3 Deaktivieren Sie im Duplicate Track-
Dialogfeld die Option Group Assignments.

4 Klicken Sie auf OK. 

Der zusammengesetzte Lautstärkepegel und der 
Mute-Status werden mit der duplizierten Spur 
addiert. Die ursprüngliche Slave-Spur wird 
bewahrt und die VCA-Gruppe ist unverändert.

Addieren der Automation über 
eine Edit-Selektion hinweg
Sie können die VCA-Automation über eine Edit-
Selektion auf einer VCA Master-Spur hinweg 
übernehmen, ohne die Automation auf die gesamte 
Länge der Spur zu übernehmen.

So addieren Sie die Automation in einer Edit-
Selektion mit einer VCA Master-Spur:

1 Wählen Sie die VCA Master-Spur aus, deren 
Automation Sie addieren möchten.

2 Nehmen Sie eine Edit-Selektion auf der VCA 
Master-Spur vor, die den Automationsbereich 
einschließt, den Sie addieren möchten.

3 Sie haben folgende Möglichkeiten:

• Halten Sie die Windows-Taste (Windows) bzw. 
Ctrl-Taste (Mac) gedrückt und wählen Sie Track 

> Coalesce VCA Master Automation. 

• Halten Sie die Windows-Taste (Windows) bzw. 
Ctrl-Taste (Mac) gedrückt, klicken Sie mit der 
rechten Maustaste auf den Namen der VCA 
Master-Spur und wählen Sie Coalesce VCA 

Master Automation. 

Der zusammengesetzte Lautstärkepegel und der 
Mute-Status werden auf jeder der Slave-Spuren 
über die Edit-Selektion hinweg übernommen. 
Die VCA Master-Lautstärke wird auf Null gesetzt, 
die VCA-Stummschaltung wird aufgehoben und 
die Automation auf dem VCA Master wird nur für 
den ausgewählten Bereich bereinigt. 
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Kapitel 46: Mixdown

Mit Pro Tools können Sie durch Aufnehmen eines 
Mixes auf neue Audiospuren oder durch Bouncen 
eines Mixes auf Festplatte eine Abmischung 
erzeugen.

Aufnehmen auf Spuren – bei diesem Vorgang 
wird genauso wie bei einem beliebigen anderen 
Eingangssignal ein Submix erstellt und auf neue 
Audiospuren aufgenommen. Für diesen Vorgang 
werden verfügbare Spuren, Voices und Buspfade 
benötigt, um den Submix und die neuen Spuren 
erstellen zu können. Bei der Aufnahme auf Spuren 
können Sie die Bedienelemente des Mischpults 
und andere Bedienelemente manuell anpassen.

Nehmen Sie auf neue Spuren auf, wenn Sie 
während des Mixdowns Bedienelemente des 
Mischpults anpassen möchten. 

Bounce auf Festplatte – mit dem Bounce to Disk-
Befehl können Sie eine endgültige Mischung, 
Effekte oder einen beliebigen Submix in neuen 
Audiodateien auf die Festplatte schreiben oder 
einen neuen Loop erstellen. Diese Methode 
ermöglicht es Ihnen, sämtliche zur Verfügung 
stehende Voices auf Festplatte zu schreiben, ohne 
eine von ihnen für diese Zwecke freizuhalten.

Als Bounce-Quelle kann jeder beliebige 
Ausgangs- oder Buspfad ausgewählt werden. 
Konvertierungen, wie etwa Samplerate-
Konvertierung und Ändern der Bitrate, können 
während oder nach dem Bounce-Vorgang 
durchgeführt werden. Obwohl Sie hören können, 

wie der Bounce in Echtzeit erstellt wird, 
ist es nicht möglich, die Bedienelemente des 
Mischpults oder andere Bedienelemente während 
eines Bounce to Disk-Vorgangs anzupassen. 

Verwenden Sie den Bounce to Disk-Befehl, wenn 
Sie die Bounce-Dateien konvertieren müssen oder 
wenn Sie während des Mixdowns nicht mit 
Bedienelementen des Mischpults interagieren 
möchten. 
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Selektieren von 
Audiomaterial für Loops, 
Submixe und Effekte
Sowohl der Bounce to Disk-Vorgang als auch das 
Aufnehmen auf Spuren erfolgen entsprechend der 
aktuellen Timeline- oder Edit-Selektion (falls 
vorhanden). Das erleichtert die Umwandlung von 
Mehrkanal-Selektionen in Mono-, Stereo- oder 
Mehrkanal-Loops. Submixe, Stems und andere 
spezielle Mischungsarten können mithilfe einer 
dieser beiden Methoden ebenfalls auf die 
Festplatte geschrieben oder auf ein anderes 
Aufnahme-, Übertragungs- oder 
Archivierungsmedium aufgenommen werden. 

Beim Schreiben von Effekten auf die Festplatte 
werden Echtzeiteffekte (etwa EQs oder Hall) einer 
Audiospur dauerhaft hinzugefügt, indem diese 
Spur mit den hinzugefügten Effekten über interne 
Busse auf neue Audiospuren aufgenommen wird. 
Das ursprüngliche Audiomaterial bleibt erhalten, 
wodurch es Ihnen möglich ist, jederzeit auf das 
Ausgangsmaterial zurückzugreifen. Das ist 
besonders dann von großem Nutzen, wenn Sie nur 
über eine begrenzte Anzahl von Spuren oder 
Effektgeräten verfügen. 

Verwenden von Dither
Mit Dithering lässt sich die Audioqualität beim 
Reduzieren der Bitrate von digitalem 
Audiomaterial deutlich verbessern. 

Verwendung eines Dither-Plug-
Ins
Sie sollten ein Dither-Plug-In immer dann 
verwenden, wenn Sie die Bitrate reduzieren, also 
etwa mit dem Bounce to Disk-Befehl beim 
Abmischen eine 16-Bit-Datei erzeugen oder Ihren 
endgültigen Mix an ein externes digitales Gerät 
senden, das bei 16 Bit aufnimmt.

Ein Dither-Plug-In ist auch beim Abmischen auf 
16 Bit aus einer 16-Bit-Session erforderlich. 
Obwohl in 16-Bit-Sessions 16-Bit-Dateien 
verwendet werden, werden diese mit höheren 
internen Bitraten verarbeitet. Pro Tools-Systeme 
verwenden 24-Bit-Audio-Eingangs- und 
Ausgangs-Signalpfade mit einer internen 64-Bit-
Gleitkommaverarbeitung zum Mischen und für die 
Audioverarbeitung.

Aus diesem Grund empfiehlt sich, unabhängig 
davon, ob Sie in einer 32-Bit-Gleitkomma-, einer 
24-Bit- oder 16-Bit-Festkomma-Session arbeiten, 
Folgendes:

• Wenn Sie auf 16 Bit abmischen, sollten Sie ein 
Dither-Plug-In auf den Hauptausgang anwenden.

• Bei der Bus-Aufnahme eines Submixes auf einer 
Spur derselben Session sollten Sie kein Dither-
Plug-In auf die Zielspur anwenden.

• Wenn Sie auf 24 Bit abmischen, sollten Sie kein 
Dither-Plug-In auf den Main Output verwenden.

• Wenn Sie mit einem 24-Bit-fähigen Interface 
auf ein analoges Zielmedium abmischen, 
wenden Sie kein Dither-Plug-In auf den 
Hauptausgang an. 

• Umgehen Sie bei der normalen Aufnahme und 
Wiedergabe jegliche Dither-Plug-Ins auf dem 
Hauptausgang.

AudioSuite-Plug-Ins bieten eine weitere 
Option zum Schreiben eines Plug-In-Effekts 
auf die Festplatte. Weitere Informationen 
finden Sie unter Kapitel 39: „AudioSuite“.
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Bounce to Disk und Dither
Beim Bouncen auf Festplatte wird Dithering nicht 
angewandt, wenn die Bitrate reduziert wird. Um 
beim Bouncen auf Festplatte Dithering 
anzuwenden, sollten Sie ein Dither-Plug-In als 
letzten Prozessor im Signalpfad auf einem Master-
Fader, der dem Audio-Ausgangspfad der Bounce-
Quelle zugewiesen ist, einfügen. 

Die Verwendung eines Dither-Plug-Ins auf einem 
Master-Fader ist besonders für einen Auxiliary-
Eingang zu empfehlen, da Master-Fader-Inserts 
Post-Fader sind. Als Post-Fader-Insert kann das 
Dither-Plug-In Änderungen auf der Master-Fader-
Ebene verarbeiten. 

Wenn Sie kein Dither-Plug-In auf Ihrem Bounce-
Quellpfad verwenden und sich während oder nach 
einem Bounce auf Festplatte dafür entscheiden, in 
eine niedrigere Auflösung zu konvertieren, wird die 
Konvertierung durch das Abschneiden der 
überzähligen Bits durchgeführt. 

Verwenden von Dithering in 
einer Ausgangsmischung
Pro Tools enthält ein Echtzeit-Dither-Plug-In, das 
die 16-, 18- oder 20-Bit-Leistung steigert und beim 
Reduzieren der Bitrate eines Ausgangsmixes 
Quantisierungsartefakte reduziert.

So wenden Sie ein Dither-Plug-In auf einen 
Ausgangsmix an:

1 Wählen Sie Track > New und erstellen Sie eine 
neue Master-Fader-Spur (Stereo).

2 Stellen Sie als Ausgang des Master-Faders den 
Ausgang oder Buspfad ein, auf den Sie bouncen 
möchten.

3 Weisen Sie denselben Pfad wie in Schritt 2 den 
Ausgängen aller Audiospuren in der Session zu. 
Der Master-Fader steuert nun die 
Ausgangspegel aller Spuren, die darauf 
geroutet sind.

4 Fügen Sie auf dem Master-Fader ein Dither-
Plug-In als letzten Prozessor in der Signalkette 
ein.

5 Wählen Sie im Dither-Plug-In-Fenster eine 
Einstellung für die Bitauflösung und 
Rauschformung (Noise Shaping) des Ausgangs.

6 Sie haben folgende Möglichkeiten:

• Geben Sie die Session wieder, um die Pro Tools-
Ausgabe auf Medien mit niedrigeren Bitraten 
(etwa 16- oder 20-Bit-Blu-Ray) aufzunehmen 
(„Layback“).

• Wählen Sie File > Bounce to > Disk. Wählen 
Sie im Bounce to Disk-Dialogfeld die 
entsprechende Bitrate (etwa 16-Bit für CD-
Audio). Bevor das Signal durch den Bounce to 

Disk-Befehl konvertiert wird, wird es 
entsprechend den Einstellungen für Auflösung 
und Rauschformung im Dither-Plug-In auf dem 
Master-Fader verarbeitet.

Samplerate-Konvertierung und 
Bitratenreduzierung
Wenn Sie beim Abmischen sowohl eine 
Konvertierung der Samplerate als auch eine 
Reduzierung der Bitrate vornehmen möchten, 
konvertieren Sie zunächst die Samplerate unter 
Beibehaltung der höheren Bitrate und reduzieren 
Sie dann bei der Datei mit der konvertierten 
Samplerate die Bitrate mithilfe eines Dithers. 
Indem Sie die höhere Bitrate während des 
Konvertierungsvorgangs beibehalten, stellen Sie 
die bestmögliche Audioqualität sicher.

 Weitere Informationen zu Dither-Plug-Ins 
finden Sie im Audio-Plug-Ins-Handbuch.
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Bus-Aufnahme auf Spuren
Sie können in Ihrer Pro Tools-Session einen 
Submix erstellen und ihn auf verfügbaren Spuren 
in derselben Session per Bus-Aufnahme 
aufnehmen. Diese Technik erlaubt es, 
der Mischung Live-Signale hinzuzufügen und 
Lautstärke, Panoramaregelung, Stummschaltung 
und andere Parameter während des 
Aufnahmevorgangs anzupassen. Sie können diese 
Methode auch statt des Bounce to Disk-Befehls 
verwenden, um Spuren direkt in der Pro Tools-
Session zu mischen.

Voice-Anforderungen für die 
Submix-Aufnahme
Das Aufnehmen eines Submix auf neue Spuren 
erfordert für jede aufzunehmende Spur eine 
verfügbare Voice. Stellen Sie also sicher, dass Sie 
genügend Voices zur Verfügung haben, um die 
entsprechenden Spuren wiederzugeben und die 
neuen Spuren aufzunehmen. 

Im Gegensatz dazu können Sie mit dem Bounce to 
Disk-Befehl zwar alle verfügbaren Voices 
ausnahmslos auf Festplatte bouncen, dafür 
aber während des Bounce-Vorgangs keinerlei 
Parameter manuell beeinflussen. Weitere 
Informationen finden Sie unter „Bounce to Disk“ 
auf Seite 1141.

So nehmen Sie einen Submix auf einer Spur auf:

1 Weisen Sie beliebige Plug-Ins oder externe 
Prozessoren, die Sie Ihren Audiospuren oder 
Auxiliary-Eingängen hinzufügen möchten, 
vor der Aufnahme zu.

2 Bestimmen Sie einen internen Buspfad für den 
Hauptkanalausgang der Spuren, die in den 
Submix aufgenommen werden sollen. Bei 
Stereo- oder Mehrkanalspuren stellen Sie die 
Panoramaregelung für jede Spur ein.

3 Vergewissern Sie sich, dass Loop Record nicht 
aktiviert ist.

4 Wählen Sie Track > New und erstellen Sie eine 
oder mehrere Mono-, Stereo- oder Mehrkanal-
Audiospuren. 

5 Wenn Sie in Stereo aufnehmen, stellen Sie die 
Panoramaregler der neuen Stereospur (oder der 
Monospuren) auf ganz links bzw. ganz rechts.

6 Stellen Sie als Eingang jeder Zielspur den 
Buspfad ein, auf den Sie aufnehmen.

7 Stellen Sie als Ausgang der neuen Spuren Ihren 
Hauptausgangspfad ein.

8 Stellen Sie sicher, dass Options > Link Timeline 

and Edit Selection ausgewählt ist.

9 Selektieren Sie den aufzunehmenden Bereich. 
Start, Ende und Länge der Aufnahme können 
durch Cursor-Positionierung oder Timeline- 
und Edit-Selektion angegeben werden. 

Informationen zum Verwalten von Voices 
finden Sie unter „Priorität von Spuren und 
Voice-Zuweisung“ auf Seite 241.

In Pro Tools|HDX-Systemen verwenden 
Native-Plug-Ins, die in Auxiliary-Eingangs-, 
Master-Fader- und Instrumentenspuren 
platziert wurden, zusätzliche Stimmen und 
können zusätzliche Latenz abhängig von der 
Hardware-Puffergröße einführen. Weitere 
Informationen finden Sie unter „Voice-
Auslastung und Gesamtlatenz für native 
(hostbasierte) Plug-Ins“ auf Seite 1039. 
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• Beim selektionsbasierten Aufnehmen findet der 
Punch-In automatisch zu Beginn der Selektion 
statt, der Punch-Out am Ende. Der selektierte 
Bereich sollte am Ende lang genug sein, um Zeit 
für Hall, Verzögerungen und andere Effekte zu 
lassen.

• Wenn Sie keine Selektion vornehmen, beginnt 
die Aufnahme an der Position des Playback-
Cursors. Der Aufnahmevorgang wird fortgesetzt 
bis Sie auf „Stop“ drücken. 

10 Schalten Sie die neuen Spuren scharf und klicken 
Sie im Transport-Fenster auf „Record“. 

11 Klicken Sie auf „Play“, um die Aufnahme des 
Submixes zu starten.

12 Wenn eine Selektion aufgenommen wird, hält die 
Aufnahme automatisch an. Wenn eine 
Aufnahme ohne Angabe eines Endpunkts 
durchgeführt wird, klicken Sie auf „Stop“ oder 
steigen Sie aus der Aufnahme aus (Punch Out). 

13 Nach der Aufnahme können Sie den über den 
Bus aufgenommenen Clip mit dem Export Clips 

as Files-Befehl exportieren (siehe „Exportieren 
eines Clips als neue Audiodatei“ auf Seite 340). 

Bounce to Disk
Mit dem Bounce to Disk-Befehl können Sie 
beliebige oder alle im System verfügbaren Voices in 
einer Abmischung (Mixdown) zusammenzufassen. 
So können Sie Aufnahmen in separate Audiodateien 
bouncen und müssen keine Spuren für einen Bounce 
frei halten. Das Bouncen kann offline (schneller 
als in Echtzeit) oder in Echtzeit erfolgen, 
sodass Sie während des Bounce-Vorgangs die 
Audiowiedergabe Ihrer Mischung anhören können.

Mit dem Bounce to Disk-Befehl können Sie Loops, 
Submixe, Stems oder andere, in Sessions erzeugte 
Audioclips exportieren. Sie können den Befehl 
außerdem verwenden, um endgültige Mono-, 
Stereo- oder Mehrkanal-Masterdateien in 
beliebigen Audiodateiformaten zu erstellen. 
Bounce to Disk bietet Konvertierungsoptionen für 
die Samplerate, die Bitauflösung und das Format. 
Sie können sogar Bounce-Dateien automatisch 
importieren, nachdem der Bounce abgeschlossen 
ist.

So verwenden Sie „Bounce to Disk“ (allgemeine 
Anweisungen): 

1 Selektieren Sie auf der Timeline den Bereich, 
der gebounct werden soll.

2 Wählen Sie File > Bounce to > Disk.

3 Konfigurieren Sie die Bounce-Optionen (siehe 
„Bounce-Optionen“ auf Seite 1143). 

4 Klicken Sie auf Bounce.
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Wenn Sie einen Bounce auf Festplatte 
durchführen, enthält die dabei entstehende Datei:

Hörbare Spuren – alle hörbaren Spuren, die auf 
den als Bounce-Quelle ausgewählten Ausgang 
geroutet sind, sind im Bounce enthalten. 
Stummgeschaltete Spuren sind im Bounce nicht 
enthalten. Wenn Sie eine oder mehrere Spuren 
sologeschaltet haben, erscheinen nur die 
sologeschalteten Elemente in der Bounce-
Mischung.

Automation – alle im Read-Modus aktivierten 
Automationsdaten werden in der Bounce-
Mischung wiedergegeben und integriert. 

Inserts und Sends – alle aktivierten Inserts, 
d. h. Echtzeit-Plug-Ins und Hardware-Inserts, 
werden auf die Bounce-Mischung angewendet.

Länge der Spuren bzw. der Selektion – wenn Sie 
in einer Spur eine Selektion vornehmen, ist die 
Bounce-Mischung so lang wie die Selektion. 
Wenn in keiner Spur eine Selektion vorgenommen 
wurde, ist die Bounce-Abmischung so lang wie die 
längste hörbare Spur der Session.

Zeitstempel – Bounce-Material wird automatisch 
mit einem Zeitstempel (Time Stamp) versehen, 
sodass Sie es auf eine Spur ziehen und an 
derselben Position wie das Originalmaterial 
platzieren können. Weitere Informationen zu 
Zeitstempeln finden Sie unter 
„Zeitstempelfunktion“ auf Seite 1226.

„Verzögerungskompensierte“ Bounce-Dateien

Pro Tools gleicht beim Bounce-Vorgang 
entstehende Bus- und Plug-In-Verzögerungen aus. 
Dies bedeutet, dass in eine Session 
zurückimportierte und zeitgleich mit der 
Originalmischung platzierte Bounce-Dateien 
zeitlich an der Originalmischung ausgerichtet 
werden.

Scharfgeschaltete Spuren und Spuren mit 
aktiviertem TrackInput können nicht gebounct 
werden

In Pro Tools können Sie keine Spuren bouncen, 
die scharfgeschaltet sind oder sich im Input Only-
Abhörmodus befinden.

Bouncen von Sends oder 
Spurenausgängen
In Pro Tools können Sie über Rechtsklick-Menüs 
das vorkonfigurierte Bounce-Dialogfeld öffnen, 
um den Kanalpfad eines bestimmten Send oder 
Spurausgangs per Rechtsklick-Menüs zu 
verwenden.

Rechtsklick-Menü des Spurausgangs im Mix-Fenster

Rechtsklick-Menü des Send im Mix-Fenster
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So führen Sie ein Bounce to Disk für einen 
Ausgangs- oder Send-Pfad durch:

1 Klicken Sie mit der rechten Maustaste auf den 
Output Path-Selektor oder den Send Path-
Selektor für den gewünschten Spurausgang 
oder Send.

2 Wählen Sie im Rechtsklick-Menü „Bounce 
<Pfad>“.

3 Das Bounce-Dialogfeld wird geöffnet und der 
Ausgangs- oder Send-Pfad ist als Bounce-
Quelle ausgewählt.

4 Konfigurieren Sie die anderen Bounce-
Einstellungen wie gewünscht und klicken Sie 
auf Bounce.

Bounce-Optionen
Bei Verwendung des Bounce to Disk-Befehls 
können Sie mehrere Dateioptionen konfigurieren.

Bounce-Quelle
Alle gegenwärtig aktivierten Ausgangspfade 
(sowohl interne Mixbusse als auch 
Ausgangsbusse) und physischen Ausgänge 
(festgelegt im I/O Setup-Dialogfeld) sind als 
Bounce-Quelle verfügbar. 

So stellen Sie die Bounce-Quelle ein:

 Wählen Sie über den Bounce Source-Selektor 
den Bus- oder Ausgangspfad oder den 
physischen Ausgang.

Bus – die gebouncte Datei enthält nur Audio, 
das auf den selektierten internen Mixbuspfad 
geroutet ist.

Output – die gebouncte Datei enthält nur Audio, 
das auf den selektierten Ausgangsbuspfad geroutet 
ist.

Physical Output – die gebouncte Datei enthält nur 
Audio, das auf den selektierten physischen Ausgang 
geroutet ist. Dies ist nützlich, wenn Sie mit sich 
überschneidenden Ausgangspfaden arbeiten. 

Gleichzeitiges Bouncen mehrerer 
Quellen
(Nur Pro Tools HD)

In Pro Tools HD können Sie gleichzeitig bis zu 
16 Quellen mit jeweils bis zu 8 Kanälen bouncen. 

So führen Sie Bounce to Disk für mehrere Quellen 
durch:

1 Selektieren Sie auf der Timeline den Bereich, 
der gebounct werden soll.

2 Wählen Sie File > Bounce to > Disk.

3 Wählen Sie unter den verfügbaren Ausgangs- 
bzw. Buspfaden die gewünschte Quelle 
(Bounce Source).

Bounce to Disk-Dialogfeld mit aktivierter 
Konvertierung und Optionen
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4 Klicken Sie im Bounce-Dialogfeld auf die 
Schaltfläche „+“ rechts vom Bounce Source-
Selektor.

5 Wiederholen Sie Schritte 3 und 4 nach Bedarf 
(bis zu 16 Quellen für gleichzeitigen Bounce).

6 Klicken Sie bei Bedarf auf die Schaltfläche „–“ 
rechts von jeder Bounce-Quelle (außer der 
ersten), um diese vom Bounce zu entfernen.

7 Konfigurieren Sie alle anderen Bounce-
Optionen wie gewünscht.

8 Klicken Sie auf Bounce.

Nachdem Sie auf Bounce geklickt haben, wird 
in einem Dialogfeld die Bounce-Zeit und -Rate 
angezeigt.

File Type
Mit dem File Type-Selektor können Sie den 
Dateityp für die Dateien auswählen, die Sie 
bouncen möchten.

WAV (Broadcast .WAV-Format)

Dieses Format wird auf Windows und Mac 
unterstützt. Um eine WAV-Datei in Pro Tools 
zu verwenden, können Sie die Datei aus dem 
Workspace-Browser, Windows Explorer, 
Mac Finder oder einem Ordner ziehen oder den 
Import Audio-Befehl anwenden. Dateien in diesem 
Format müssen zur Verwendung in Pro Tools 
nicht konvertiert werden.

AIFF (Audio Interchange File Format)

Dieses Format wird auf Windows und Mac 
unterstützt. Zur Verwendung von AIFF-Dateien 
in Pro Tools benutzen Sie den Import Audio-Befehl 
oder den Wokspace-Browser, Windows Explorer 
oder Mac Finder, aus denen Sie Dateien per Drag & 
Drop übertragen können. Dateien in diesem Format 
müssen zur Verwendung in Pro Tools nicht 
konvertiert werden.

Drücken Sie auf dem Mac Befehl + 
Umschalt + „+“ (Plus) oder Befehl + 
Umschalt + Pfeiltaste nach unten oder 
Befehl + Umschalt + N, um eine neue 
„Bounce Source“-Reihe hinzuzufügen. 
Drücken Sie in Windows Strg + 
Umschalt + „+“ (Plus) oder Strg + 
Umschalt + Pfeiltaste nach unten oder Strg + 
Umschalt + N, um eine neue „Bounce 
Source“-Reihe hinzuzufügen.

Bounce-Dialogfeld mit mehreren ausgewählten 
Bounce-Quellen

Drücken Sie auf dem Mac Befehl + 
Umschalt + „–“ (Minus) oder Befehl + 
Umschalt + Pfeiltaste nach oben, um die 
unterste „Bounce Source“-Reihe zu entfernen. 
Drücken Sie in Windows Strg + 
Umschalt + „–“ (Minus) oder Strg + 
Umschalt + Pfeiltaste nach oben, um die 
unterste „Bounce Source“-Reihe zu entfernen.
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MP3 (MPEG-1 Layer 3)

Das MPEG-1 Layer 3-Kompressionsformat (MP3) 
wird dazu verwendet, um Audiomaterial live über das 
Internet zu übertragen und herunterzuladen und es auf 
tragbaren Abspielgeräten wiederzugeben. 

Wenn Sie dieses Format wählen, steht bei 
Pro Tools im Output Options-Dialogfeld das 
Resolution-Popup-Menü nicht zur Verfügung. Die 
Auflösung wird vom Encoder festgelegt.

Die gewählte Samplerate wird an den Codec als 
„Basis“-Samplerate für alle Vorgänge ausgegeben. 
Die tatsächliche Samplerate der resultierenden 
Datei wird im MP3 Encoder Options-Dialogfeld 
festgelegt. Wenn beispielsweise eine Basis-
Samplerate von 48.000 Hz gewählt wird, haben 
Sie im MP3 Encoder Options-Dialogfeld, 
abhängig von der Kodierungsqualität, die Wahl 
zwischen Ausgangs-Streams in 48, 24 oder 
12 kHz.

Beim Exportieren oder Bouncen in das MP3-
Format stehen folgende Optionen zur Verfügung:

Encoder-Einstellungen

Encoder Speed – bestimmt die Audioqualität der 
Bounce-Datei. Es stehen die folgenden zwei 
Optionen zur Auswahl: Highest Quality (höchste 
Qualität) und Fastest Encoding Time (kürzeste 
Kodierungsdauer). 

Mit der Highest Quality-Einstellung kann die 
Verarbeitung des Audiomaterials bis zu fünfmal 
länger dauern als mit der Fastest Encoding-
Einstellung. Es ist deshalb ratsam, nur dann mit 
„Highest Quality“ zu arbeiten, wenn höchste 
Klangqualität entscheidend ist und Sie ausreichend 
Zeit für den längeren Kodierungsvorgang zur 
Verfügung haben. 

Constant Bit Rate (CBR) – mit dieser Option wird 
die Datei mit einer festen Bitrate kodiert, die Sie 
aus dem Constant Bit Rate (CBR)-Popup-Menü 
auswählen können. Da die Bitrate hier fest 
eingestellt ist, variiert die Qualität des kodierten 
Audiomaterials je nach Beschaffenheit des 
zu komprimierenden Materials. Die Option 
128 kbit/s eignet sich am besten für Übertragungen 
über das Internet, da die Internetverbindung 
vorhersehbare Anforderungen an die Bandbreite 
stellt. 

Enable MP3 Surround Encoding – diese Option 
ist nur verfügbar, wenn Sie Stereomaterial nach 
Interleaved MP3 bouncen. Das Stereomaterial 
wird hochgemixt und als 5.1-Mehrkanal-
Surround-Datei kodiert, die auch als Stereo-MP3 
wiedergegeben werden kann.

ID3 Tag Info-Einstellungen

ID3 Tag Type – der ID3-Tag speichert Daten über 
die kodierte Audiodatei, damit der jeweilige MP3-
Player Informationen über diese Datei anzeigen 
kann. Pro Tools unterstützt drei Versionen dieses 
Tags, um Abwärtskompatibilität zu älteren MP3-
Playern zu gewährleisten: 

• ID3 v1.0: Erscheint am Ende einer gestreamten 
MP3-Datei, d. h., die Tag-Informationen werden 
erst am Ende des Stream-Vorgangs angezeigt.

MP3-Export-Optionen

Ausführliche Informationen zu den 
Voraussetzungen für die Wiedergabe von 
MP3-Surround finden Sie auf 
www.fraunhofer.com.
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• ID3 v1.1: Wie Version 1.0, mit dem 
Unterschied, dass dem Tag hier Informationen 
zur Spurnummer hinzugefügt werden.

• ID3 v2.3: Erscheint am Anfang einer 
gestreamten MP3-Datei, d. h., die Tag-
Informationen werden bereits am Anfang des 
Stream-Vorgangs angezeigt.

Title/Artist/Album/Comment – geben Sie Titel, 
Künstler und weitere Informationen zur MP3-
Datei ein. Diese Angaben werden von zahlreichen 
MP3-Playern angezeigt.

Genre – wählen Sie ein Genre für Ihre Datei. Diese 
Angabe wird von vielen MP3-Playern angezeigt 
und kann in Katalogen und Datenbanken angezeigt 
werden, die über eine Suchfunktion verfügen.

Spurnummer – wenn Sie als ID3-Tag-Typ „v1.1“ 
oder „v2.3“ auswählen, können Sie eine CD-
Track-Nummer für die Datei eingeben. Diese 
Angaben werden von zahlreichen MP3-Playern 
angezeigt.

Year – geben Sie die entsprechende Jahresangabe 
für die Datei ein. Diese Angaben werden von 
zahlreichen MP3-Playern angezeigt.

Mac-Dateieinstellungen

Mac File Type and Creator – wenn die Datei auf 
einem Mac verwendet werden soll, können Sie 
hier den Dateityp und den Ersteller eingeben. Dies 
ermöglicht den Benutzern, ihren MP3-Player mit 
einem Doppelklick auf die Datei zu öffnen.

Default-Schaltfläche

Um alle Einstellungen dieses Dialogfelds auf ihre 
voreingestellten Werte zurückzusetzen, klicken 
Sie auf Defaults.

QuickTime 

QuickTime ist das Audiodateiformat von Apple 
für Multimedia-Anwendungen. Pro Tools 
unterstützt diesen Dateityp in seinen Sessions 
nicht direkt. Für QuickTime-Audiodateien in 
Pro Tools müssen Sie den Import Audio-Befehl 
verwenden. Das QuickTime-Format ist besonders 
geeignet für E-Mail-Anhänge, um beispielsweise 
im Rahmen von Projektarbeiten über große 
Distanzen Medien auszutauschen, zu prüfen und 
zu genehmigen. QuickTime wird zudem von 
zahlreichen Multimedia-Anwendungen 
unterstützt.

Windows Media 
(Nur Windows)

Mit Windows Media formatierte Dateien können 
Audio-, Video- oder Script-Daten im Windows 
Media-Format enthalten. Dateien im Windows 
Media-Format können die Dateierweiterungen .asf 
oder .wmv haben.

MXF (Material Exchange Format)

MXF ist ein Mediendateiformat, das für Video- und 
Audiodateien verwendet wird und für den Austausch 
von audiovisuellem Material mit verbundenen Daten 
und Metadaten entwickelt wurde. Das Format sollte 
die dateibasierte Interoperabilität zwischen Servern, 
Workstations und anderen Inhalt erstellenden Geräten 
verbessern.

Dateien im AAF- und OMF-Sequenzformat 
können auf MXF-Mediendateien verweisen oder 
eingebettete MXF-Mediendateien enthalten. 
Pro Tools unterstützt eingebettete AAF-
Sequenzen.

Obwohl ID3 v2.3 aktuell das Standard-MP3-
Format ist, wird es noch nicht von allen 
MP3-Playern unterstützt. Wenden Sie sich 
mit Fragen zur Kompatibilität an den 
Hersteller der Player-Software.
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Gleichzeitiges Bouncen in MP3 und 
einen anderen Dateityp

Mit der neuen Add MP3-Option im „Bounce to 
Disk“-Dialogfeld können Sie zusätzlich zum 
ausgewählten Dateityp (wie etwa WAV) 
gleichzeitig eine MP3-Version jeder Bounce-
Quelle erstellen.

Wenn die Add MP3-Option ausgewählt ist und Sie 
den Bounce Ihrer iTunes-Mediathek hinzufügen 
oder über Gobbler bzw. SoundCloud freigeben, 
wird der ausgewählte Dateityp anstelle der MP3 
verwendet. Um eine MP3-Datei freizugeben, 
wählen Sie bei File Type die MP3-Option.

Die Add MP3-Option ist für QuickTime-Bounce 
nicht verfügbar.

So führen Sie Bounce to Disk für mehrere Quellen 
durch:

1 Selektieren Sie auf der Timeline den Bereich, 
der gebounct werden soll.

2 Wählen Sie File > Bounce to > Disk.

3 Wählen Sie den gewünschten File Type.

4 Wählen Sie die Add MP3-Option (nur Bounce-
Quellen in Mono oder Stereo).

5 Konfigurieren Sie alle anderen Bounce-
Optionen wie gewünscht.

6 Klicken Sie auf Bounce.

7 Konfigurieren Sie das angezeigte MP3-
Dialogfeld wie gewünscht und klicken Sie auf 
OK.

Format
Hierbei handelt es sich um das Format für die 
Bounce-Ergebnisse. Sie können zwischen den 
Optionen Mono (Summed), Multiple Mono und 
Interleaved wählen. 

So stellen Sie das Format der Bounce-Datei ein:

 Wählen Sie aus dem Format-Selektor ein 
Dateiformat aus.

Mono (Summed) – erzeugt eine einzelne 
Audiodatei, in die ein kompletter Mono-Mix aller 
hörbaren Spuren der Session geschrieben wird. 

Vor Bounce to Disk sollten Sie sicherstellen, dass 
die Pegel unter -3 dB liegen, um Übersteuerungen 
zu vermeiden, die auftreten, wenn die linken und 
rechten Signale näher als -3 dB am Maximum oder 
Vollpegel (0 dBFS) liegen.

Multiple Mono – erzeugt mehrere Monodateien, 
die die gleiche Anzahl an Kanälen aufweisen wie 
der Quellpfad. 

• Wenn es sich beim Ausgang der Quelle oder 
dem Buspfad um Stereo handelt, werden zwei 
Monodateien erzeugt, die beim Bouncing die 
Suffixe „.L“ und „.R“ erhalten. 

• Wird ein Mehrkanal-Format benutzt (etwa 
Sechskanal-Format, 5.1), werden für jeden 
Kanal des Pfads einzelne Monodateien erstellt. 
Die Dateien erhalten ein Pfadsuffix, das sich auf 
die Pfaddefinition des I/O Setup-Dialogfelds 
stützt.

• Wenn es sich beim Ausgang der Quelle oder 
dem Buspfad um Mono handelt, wechselt das 
Popup-Menü von „Multiple Mono“ zu „Mono“ 
und erstellt eine Monodatei (ohne 
Zusammenführung mehrerer Quellen).
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Interleaved – erzeugt eine einzelne sogenannte 
Interleaved-Datei, die sämtliche Bounce-Streams 
des gewählten Ausgangspfads enthält. In einem 
Interleaved-Stereo-Bounce werden Spuren, auf die 
ungerade Ausgänge geroutet sind, an den linken 
Kanal und Spuren, auf die gerade Ausgängen 
geroutet sind, an den rechten Kanal gesendet.

Mit Pro Tools können Sie auch Mehrkanal-
Interleaved-Dateien in einem beliebigen 
unterstützten Mehrkanalformat (beispielsweise 
5.1) bouncen. Dies kann die Dateiverwaltung von 
Mischungen und Projekten bei Backups und der 
Archivierung bedeutend vereinfachen. 

Bit Depth
Mithilfe dieser Einstellung können Sie zwischen 
vier verschiedenen Bitrates für die Bounce-
Konvertierung wählen. Beachten Sie, dass der 
Bounce to Disk-Befehl beim Konvertieren während 
oder nach einem Bounce in eine niedrigere 
Auflösung kein Dithering anwendet. Wenn Sie 
einen Bounce in eine Datei mit niedrigerer 
Auflösung benötigen, verwenden Sie ein Dither-
Plug-In auf einer Master-Fader-Spur, die mit dem 
Pfad der Bounce-Quelle verknüpft ist. Dadurch 
wird der Dither-Effekt auf die gebouncte Datei 
angewendet, bevor die Bounce to Disk-
Konvertierung die gebouncte Datei auf die 
ausgewählte Bit Depth-Auflösung kürzt. (Siehe 
„Verwenden von Dither“ auf Seite 1138.)

Die folgenden Bit Depth-Optionen stehen zur 
Verfügung:

16-Bit – hierbei handelt es sich um die Standard-
Bitauflösung von Compact Discs (CDs). 

24-Bit – diese Einstellung bietet die höchste 
Auflösung, die auch mit den meisten Audio-
Interfaces kompatibel ist. Sie ist nützlich, wenn Sie 
eine endgültige Mischung ohne 
Auflösungsverluste erstellen, um sie 
beispielsweise als Master zu verwenden.

32-Bit-Gleitkomma – diese Einstellung bietet die 
höchste Auflösung bei internem Pro Tools-Mixing 
und Plug-In-Verarbeitung. Sie ist besonders 
nützlich, wenn Sie Loops und Sound-Effekte 
exportieren und erneut in Ihre Pro Tools-Session 
importieren möchten, oder wenn Sie Dateien 
zwischen mehreren Pro Tools-Sessions 
austauschen.

So stellen Sie die Auflösung der Bounce-Datei ein:

 Wählen Sie die gewünschte Bitrate im Bit 

Depth-Selektor.

Sample Rate
Über diese Option können Sie Ihr Audiomaterial 
mit unterschiedlichen Samplerates speichern. Die 
Auswahlmöglichkeiten hängen vom Pro Tools-
System und den Audio-Interfaces ab. Sie können 
zwischen Samplerates von 8 kHz bis 192 kHz 
wählen, einschließlich Samplerates mit Pull-Up- 
und Pull-Down-Optionen.

Samplerate-Konvertierungs-Qualität

Bei Auswahl einer Samplerate, die nicht der 
ursprünglichen Samplerate der Session entspricht, 
stehen Ihnen verschiedene 
Konvertierungsoptionen zur Verfügung. Sie 
können die Qualität der Konvertierung 
konfigurieren und bestimmen, ob sie während oder 
nach dem Bounce vorgenommen werden soll. 
Weitere Hinweise finden Sie unter „Samplerate-
Konvertierungs-Qualität“ auf Seite 1149.

Wenn Sie in einer 16-Bit-Session arbeiten, 
sollten Sie trotzdem einen Dither auf den 
Ausgangsmix anwenden, weil alle Pro Tools-
Systeme intern mit höheren Bitraten arbeiten.
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Häufige Samplerates

Im Folgenden werden die gängigsten Samplerates 
mit Anwendungsbeispielen aufgeführt: Höhere 
Samplerates bieten eine bessere Qualität bei der 
Audioaufnahme und -wiedergabe sowie bei der 
Dynamikverarbeitung, beim Dithering (mit 
Rauschformung) und bei der Verwendung von 
analogen Emulations-Plug-Ins.

192 kHz – dies ist eine von einigen Audio-DVDs 
unterstützte Samplerate, die die beste 
Audioqualität mit kompatiblen Audio-Interfaces 
(etwa dem HD I/O) bietet.

176,4 kHz – wenn das Endprodukt mit 44,1 kHz 
ausgegeben werden soll (etwa auf einer CD), 
sollten Sie mit einer Samplerate von 176,4 kHz 
arbeiten. Die Samplerate-Konvertierung zu 
44,1 kHz verläuft dann schneller als von 192 kHz.

96 kHz – dies ist eine von Audio-DVDs 
unterstützte Samplerate, die sehr gute 
Audioqualität mit kompatiblen Audio-Interfaces 
(etwa HD I/O und 003) bietet. 

88,2 kHz – wenn das Endprodukt mit 44,1 kHz 
ausgegeben werden soll (etwa auf einer CD), 
sollten Sie mit einer Samplerate von 88,2 kHz 
arbeiten. Die Samplerate-Konvertierung zu 
44,1 kHz verläuft dann schneller als von 96 kHz.

48 kHz – dies ist die Standard-Samplerate für 
professionelle und DVD-Videos, die auch bei der 
Archivierung im Broadcast- und Aufnahmebereich 
verwendet wird. Sie wird von DA-88/98-, DAT- und 
ADAT-Rekordern unterstützt.

44,1 kHz – dies ist die Standard-Samplerate für 
CDs. Sie wird von DA-88/98-, DAT- und ADAT-
Rekordern unterstützt.

Weitere Samplerates: 8 kHz, 11,025 kHz, 16 kHz, 
22,050 kHz und 32 kHz.

Benutzerdefiniert – um eine benutzerdefinierte 
Samplerate festzulegen, klicken Sie in das Sample 
Rate-Fenster und geben Sie manuell einen Wert 
zwischen 4.000 und 200.200 Samples ein.

Pull-Up- und Pull-Down-Raten – alle zur 
Verfügung stehenden Samplerates unterstützen 
Pull-Up- und Pull-Down-Raten oder andere 
spezifische Raten. 

Samplerate-Konvertierungs-
Qualität
Wenn Sie eine andere Samplerate für eine Bounce-
Datei angeben (etwa beim Abmischen einer mit 
96 kHz aufgenommenen Session zum Release auf 
einer Audio-CD mit 44,1 kHz), verwendet 
Pro Tools die Conversion Quality-Option, um die 
Qualität der Samplerate-Konvertierung zu 
bestimmen. 

Es stehen fünf mögliche Einstellungen zur 
Verfügung, die von Low (niedrigste Qualität) bis 
Tweak Head (höchste Qualität) reichen. Je höher 
die gewählte Konvertierungsqualität der 
Samplerate ist, desto länger dauert die 
Konvertierung der Bounce-Datei.

Enforce Avid Compatibility
Durch Aktivieren dieser Option im Bounce to 
Disk-Dialogfeld wird eine gebouncte Datei mit 
framegenauen Edits erstellt, als OMFI (sofern der 
Dateityp nicht MXF ist) behandelt und die 
Samplerate-Optionen auf 44,1 oder 48 kHz 
begrenzt. Dithering ohne Rauschformung (Noise 
Shaping) wird auf Dateien angewendet, die von 
24 Bit nach 16 Bit exportiert werden.



Pro Tools-Referenzhandbuch1150

Zur iTunes-Mediathek 
hinzufügen
In Pro Tools können Sie Ihren Mix über die Add to 

iTunes Library-Option im Bounce to Disk-
Dialogfeld in Ihre iTunes-Mediathek bouncen. Ist 
diese Option aktiv, wird die gebouncte Datei 
in Ihre lokale iTunes-Mediathek kopiert. Sie 
können den Speicherort für Ihre iTunes-Mediathek 
festlegen, indem Sie die neue iTunes Library 

Folder-Einstellung in den Pro Tools Operation-
Voreinstellungen verwenden.

Ist die Add to iTunes Library-Option beim Bounce 
auf die Festplatte aktiviert, wird die resultierende 
Audiodatei automatisch in die iTunes-Mediathek 
importiert, wenn Sie iTunes das nächste Mal 
öffnen. Sollte iTunes auf Ihrem Computer nicht 
installiert sein, hat diese Option keine 
Auswirkung.

So exportieren Sie Ihren Mix in Ihre iTunes-
Mediathek:

1 Wählen Sie File > Bounce to > Disk.

2 Wählen Sie im Bounce to Disk-Dialogfeld die 
Bounce Source und legen Sie die übrigen 
Optionen fest.

3 Aktivieren Sie die Add to iTunes Library-
Option.

4 Klicken Sie auf Bounce.

Import After Bounce
Die Import After Bounce-Option importiert die 
neuen Bounce-Dateien automatisch in die 
Clipliste, von wo aus Sie sie auf Spuren platzieren 
können. Wenn es sich bei Ihren neu gebouncten 
Dateien um gesplittete Stereodateien handelt 
(Mehrkanal-Mono), werden sie zusammen in der 
Clipliste aufgeführt.

Veröffentlichen auf SoundCloud
SoundCloud ist eine Social Network-Website zum 
Veröffentlichen von Audiodateien. Benutzer 
erstellen ein öffentliches Profil und laden 
Audioinhalte hoch, die sie anderen zugänglich 
machen möchten. Diese Audios werden entweder 
allen oder nur einer Gruppe ausgewählter Benutzer 
zugänglich gemacht. Dank der einfachen Optionen 
in SoundCloud können Sie Ihre Tracks oder 
Playlists auf einer beliebigen Website 
veröffentlichen, darunter andere Social Network-
Seiten (wie Twitter, Facebook und Google+).

Pro Tools erlaubt Ihnen das Veröffentlichen Ihrer 
Mixes auf SoundCloud mit Hilfe der Share With 

SoundCloud-Option im Bounce to Disk-
Dialogfeld oder im Export Selected-Dialogfeld. 
Bei aktivierter Option wird die gebouncte 
(oder exportierte) Datei automatisch in Ihr 
SoundCloud-Konto hochgeladen. Wenn Sie noch 
kein Konto haben, können Sie kostenlos eines 
erstellen. 

Die Add to iTunes Library-Option ist nur 
verfügbar, wenn für die Bounce-Quelle ein 
Mono- oder Stereopfad festgelegt und das 
Format auf „Mono (Summed)“ oder 
„Interleaved“ eingestellt ist.

Die Import After Bounce-Option ist nur 
verfügbar, wenn der Zieldateityp und die 
Samplerate für den Bounce dem Dateityp und 
der Samplerate der aktuellen Session 
entspricht und die Zielauflösung (Bitrate) 
gleich oder kleiner als die Auflösung der 
Session ist. Außerdem können Spuren, die in 
eine Interleaved-Stereodatei gebounct 
wurden, nicht automatisch nach dem Bounce 
importiert werden.
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So veröffentlichen Sie per „Bounce auf Festplatte“ 
Audios auf SoundCloud:

1 Wählen Sie File > Bounce to > Disk.

2 Wählen Sie im Bounce to Disk-Dialogfeld die 
Einstellungen für Bounce Source, File Type, Bit 

Depth und Sample Rate. 

3 Vergewissern Sie sich, dass das Format auf Mono 

(Summed) oder Interleaved eingestellt ist.

4 Wählen Sie im Share With-Popup-Menü 
SoundCloud.

5 Klicken Sie auf Bounce.

6 Konfigurieren Sie das Share With SoundCloud-
Dialogfeld (siehe „Share with SoundCloud-
Dialogfeld“ auf Seite 1151).

7 Klicken Sie auf Share.

8 Wenn Sie noch nicht bei Ihrem SoundCloud-
Konto angemeldet sind, werden Sie 
aufgefordert, sich anzumelden (siehe 
„Anmelden bei Gobbler“ auf Seite 1153).

Die gebouncte Datei wird auf Ihre lokale Festplatte 
geschrieben und dann, wenn Sie angemeldet sind, 
direkt in Ihrem SoundCloud-Konto gepostet.

Überwachen des Upload-Fortschritts

Der Upload-Fortschritt kann im Task Manager 
(Window > Task Manager) überwacht werden.

Ist im Share with SoundCloud-Dialogfeld die 
Option Notify me when the upload is complete 
aktiviert, werden Sie über das Upload Successful-
Dialogfeld (in dem Sie die URL in die 
Zwischenablage kopieren können) benachrichtigt, 
sobald die gebouncte Datei in Ihrem SoundCloud-
Konto gepostet wurde.

Anmelden bei SoundCloud

So melden Sie sich bei Ihrem SoundCloud-Konto 
an (oder erstellen eines):

1 Wählen Sie Setup > Connect To > SoundCloud.

2 Sie haben folgende Möglichkeiten:

• Um ein bestehendes Konto zu benutzen, geben 
Sie Ihre Email\Login-Daten sowie das Password 
für Ihr SoundCloud-Konto ein und klicken Sie 
auf die Connect-Schaltfläche.

• Um ein neues Konto zu erstellen, klicken Sie auf 
die Not a member? Signup! -Schaltfläche. 
Sobald die SoundCloud-Website in Ihrem 
Standard-Webbrowser geöffnet ist, folgen Sie 
den Anweisungen auf dem Bildschirm.

Share with SoundCloud-Dialogfeld

Im „Share with SoundCloud“-Dialogfeld befinden 
sich Texteingabefelder, Einstellungen und 
Optionen, mit deren Hilfe Sie festlegen, welche 
Informationen zusammen mit dem in SoundCloud 
hochgeladenen Track veröffentlicht werden. 
Es enthält weiterhin Lizenz- und 
Berechtigungseinstellungen, mit denen bestimmt 
wird, wofür Ihre Tracks genutzt werden können 
und wer sie sehen kann. Die Informationen, 
Optionen und Einstellungen für Ihre Tracks 
können Sie später online in Ihrem SoundCloud-
Konto bearbeiten.

Die Share With SoundCloud-Option ist nur 
verfügbar, wenn das Format auf „Mono 
(Summed)“ oder „Interleaved“ eingestellt 
ist.

Weitere Informationen zu SoundCloud finden 
Sie unter www.soundcloud.com.
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Titel

Hier geben Sie den Title für den Track ein, den Sie 
in SoundCloud hochladen.

Beschreibung

Geben Sie eine Description für den Track ein, den 
Sie in SoundCloud hochladen.

Lizenz

Wählen Sie die passende License-Option für den 
Track, den Sie in SoundCloud hochladen.

Typ

Wählen Sie den Track-Type, den Sie in 
SoundCloud hochladen.

Kann heruntergeladen werden

Die Option Downloadable wählen Sie für Tracks, 
von denen Sie möchten, dass sie aus SoundCloud 
heruntergeladen werden können. Ist diese Option 
nicht aktiviert, kann der Track nur gestreamt 
(online angehört) werden, nicht aber 
heruntergeladen.

Genre

Geben Sie ein Genre an für den Track, den Sie in 
SoundCloud hochladen.

Tags

Geben Sie Tags ein, mit denen der Track 
gekennzeichnet wird, den Sie in SoundCloud 
hochladen. Trennen Sie die Tags jeweils mit einem 
Leerzeichen. Tags mit mehreren Worten werden 
am besten in Anführungsstriche gesetzt.

Private Spur

Aktivieren Sie Private Track, damit der Tack, den 
Sie in SoundCloud hochladen, nur für bestimmte 
Personen sichtbar ist. Ist diese Option aktiv, 
können Sie E-Mail-Adressen von Personen 
eingeben, die auf Ihren Track zugreifen können 
sollen. Trennen Sie E-Mail-Adressen durch ein 
Komma.

Benachrichtigung

Aktivieren Sie Notify me when the upload is 

complete, um eine Meldung zu erhalten, wenn der 
Track-Upload in Ihr SoundCloud-Konto 
abgeschlossen wurde.

Veröffentlichen auf Gobbler
Pro Tools erlaubt Ihnen das Veröffentlichen Ihrer 
gebouncten und exportierten Mixes auf Gobbler 
mit Hilfe der Share with Gobbler-Option im 
Bounce to Disk-Dialogfeld sowie im Export 
Selected-Dialogfeld. Bei aktivierter Option wird 
die gebouncte oder exportierte Datei automatisch 
über Ihr Gobbler-Konto an Ihre Kollegen 
gesendet. Wenn Sie noch kein Konto haben, 
können Sie kostenlos eines erstellen.

Weitere Informationen finden Sie unter 
www.soundcloud.com.

Share with SoundCloud-Dialogfeld

Weitere Informationen zu Gobbler finden Sie 
auf www.gobbler.com.
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So veröffentlichen Sie per „Bounce to Disk“ Mixes 
auf Gobbler:

1 Wählen Sie File > Bounce to > Disk.

2 Wählen Sie im Bounce to Disk-Dialogfeld die 
Einstellungen für Bounce Source, File Type, 
Format, Bit Depth und Sample Rate. 

3 Wählen Sie im Share With-Popup-Menü 
Gobbler.

4 Klicken Sie auf Bounce.

5 Wenn Sie noch nicht bei Ihrem Gobbler-Konto 
angemeldet sind, werden Sie aufgefordert, sich 
anzumelden (siehe „Anmelden bei Gobbler“ 
auf Seite 1153).

6 Sobald Sie bei Ihrem Gobbler-Konto 
angemeldet sind, wird die Gobbler-Anwendung 
gestartet.

7 Geben Sie im Send Files-Dialogfeld der 
Gobbler-Anwendung die E-Mail-Adresse ein, 
an die die Audiodatei gesendet werden soll. 

8 Stellen Sie ggf. weitere verfügbare Optionen 
ein.

9 Klicken Sie auf Send.

Anmelden bei Gobbler

So melden Sie sich bei Ihrem Gobbler-Konto an:

1 Wählen Sie Setup > Connect To > Gobbler.

2 Sie haben folgende Möglichkeiten:

• Um ein bestehendes Konto zu benutzen, geben 
Sie Ihre Email\Login-Daten sowie das Password 
für Ihr Gobbler-Konto ein und klicken Sie auf 
die Connect-Schaltfläche.

• Um ein neues Konto zu erstellen, klicken Sie auf 
die Not a member? Signup! -Schaltfläche. 
Sobald die Gobbler-Website in Ihrem Standard-
Webbrowser geöffnet ist, folgen Sie den 
Anweisungen auf dem Bildschirm, um Ihr 
Konto zu erstellen und die kostenlose Gobbler-
Anwendung zu installieren.

Bounce-Dateiname
Pro Tools bietet ein File Name-Texteingabefeld 
für Bounce to Disk. Geben Sie im Bounce-
Dialogfeld den gewünschten Dateinamen für die 
gebouncte Datei ein. Für Bounces aus mehreren 
Quellen wird der eingegebene Dateiname mit dem 
Namen der Bounce-Quelle und einer Nummer 
(fortlaufend für jede Quelle) angehängt: 
„<Dateiname>_<Quellname>_<n>“.

System-VST-Plug-In-Verzeichnis
Klicken Sie auf die Choose-Schaltfläche, um ein 
anderes Verzeichnis für gebouncte Dateien als den 
Standardpfad festzulegen.

Offline-Bounce
Pro Tools bietet eine Offline-Option für Bounce to 

Disk und Bounce to QuickTime. Damit können Sie 
in den meisten Fällen schneller als in Echtzeit 
bouncen (je nach Größe des Session-Mixers und 
der DSP-Plug-In-Ausstattung).

Informationen zur Verwendung des Send To 
Gobbler-Befehls finden Sie unter „Senden von 
Sessions an Gobbler“ auf Seite 384.
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So führen Sie Offline-Bounce to Disk für Audio 
durch:

1 Selektieren Sie auf der Timeline den Bereich, 
der gebounct werden soll.

2 Wählen Sie File > Bounce to > Disk.

3 Aktivieren Sie im Bounce-Dialogfeld die 
Offline-Option.

4 Konfigurieren Sie die Bounce-Optionen wie 
gewünscht.

5 Klicken Sie auf Bounce.

Nachdem Sie auf Bounce geklickt haben, wird 
in einem Dialogfeld die Bounce-Zeit und -Rate 
angezeigt.

Einschränkungen des Offline-Bounce

Wenn Sie die Offline-Bounce-Option verwenden, 
sind folgende Elemente nicht im Bounce 
enthalten:

• Hardware-Inserts

• Externes MIDI-gesteuertes Audio (wie externe 
MIDI-Synthesizer oder -Sampler)

• Externe Audioquellen, die über Auxiliary-
Eingangs-Spuren abgehört werden

• Nur-DSP-Plug-Ins (Offline-Bounce verwendet 
immer die Native-Version von DSP-Plug-Ins, 
jedoch nur wenn verfügbar)

• Audioquellen, die extern synchronisiert werden

Geschwindigkeit des Offline-Bounce

Die Geschwindigkeit des Offline-Bounce wird 
durch Folgendes beeinflusst: 

• Prozessorauslastung – die Geschwindigkeit 
Ihres Prozessors und die Beanspruchung des 
Prozessors durch das System und anderen 
Anwendungen. Sie können die 
Prozessorauslastung im „System Usage“-
Fenster überwachen.

• Speicherbedarf – wenn beispielsweise die bei 
der Wiedergabe einer Session die Disk-Anzeige 
im „System Usage“-Fenster 50 % anzeigt, stößt 
der Offline-Bounce bei der doppelten Echtzeit-
Geschwindigkeit an seine Grenzen, weil es 
physisch unmöglich ist, die Daten schnell genug 
von der Festplatte zu lesen. Wenn Sie die Disk 

Playback Cache Size erhöhen können (Setup > 

Playback Engine), um alles Audio in der 
Timeline zwischenzuspeichern, sollte es kein 
Problem geben (nur Pro Tools HD).

• Bei einer ungleichmäßigen Auslastung der 
Core-Prozessoren aufgrund großer Mixer und 
der Verwendung von Native-Plug-Ins können 
Sie überprüfen, ob die Prozessoranzeigen für die 
einzelnen Cores im CPU-Bereich des „System 
Usage“-Fensters ungleichmäßig sind. Das 
Entfernen oder Deaktivieren von Native-Plug-
Ins auf Auxiliary-Eingangs- und Master-Fader-
Spuren kann helfen, das Problem zu beheben.

• Einige Plug-Ins von Drittanbietern können den 
Offline-Bounce aufgrund ihrer 
Prozessoranforderungen verlangsamen.

Dialogfenster mit dem Fortschritt des Offline-Bounce

Bei Pro Tools HD-Systemen mit HDX-
Hardware ist im Bounce-Pfad vorhandene 
HEAT-Verarbeitung im Offline-Bounce 
enthalten.

Beachten Sie, dass bei einigen Sessions mit 
umfangreichen Mixer-Konfigurationen und 
vielen DSP-basierten Plug-Ins und 
Automation der Offline-Bounce 
möglicherweise langsamer als das Bouncen 
in Echtzeit ist.
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Abbrechen
Mit der Cancel-Schaltfläche schließen Sie das 
Bounce to Disk-Dialogfeld, ohne die Bounce to 
Disk-Konvertierung zu starten.

Bounce
Mit der Bounce-Schaltfläche können Sie die 
Bounce to Disk-Konvertierung initiieren. 
Anschließend wird ein Save-Dialogfeld geöffnet, 
in dem Sie an den Ort navigieren können, an dem 
Sie die Datei ablegen möchten, die gebounct 
werden soll. Sobald Sie den Speicherort festgelegt 
und auf Save geklickt haben, wird ein Fenster mit 
Fortschrittsanzeige geöffnet, in dem Sie sehen 
können, wie viel Zeit noch für den Bounce-
Vorgang benötigt wird.

Aufnehmen eines Submixes 
(mit Bounce to Disk)
Mit dem Bounce to Disk-Befehl können Sie 
Submixe erstellen, indem Sie Spuren 
stummschalten oder Inserts per Bypass umgehen, 
die nicht Teil des Submixes sein sollen, und den 
Teil der Session selektieren, den Sie bouncen 
möchten. Alternativ können Sie auch nur das 
Audio soloschalten, das Sie bouncen möchten.

Sie können einen Submix jedoch auch durch 
Aufnehmen auf neue Spuren erzeugen. Weitere 
Hinweise finden Sie unter „Samplerate-
Konvertierung und Bitratenreduzierung“ auf 
Seite 1139.

So bouncen Sie einen Submix auf die Festplatte:

1 Konfigurieren Sie Ihren Submix mit Sends, 
Auxiliary-Eingängen und Master-Fadern. 
(Siehe „Signal-Routing zum Abhören und 
Erstellen von Submixes“ auf Seite 1014.)

2 Sie haben folgende Möglichkeiten:

• Wenn Sie die gesamte Session bouncen 
möchten, klicken Sie im Transport-Fenster auf 
„Return to Zero“, um an den Beginn der Session 
zu gelangen. 

• Wenn Sie jedoch nur einen Abschnitt der Session 
bouncen möchten, aktivieren Sie Options > Link 

Timeline and Edit Selection und nehmen Sie im 
Edit-Fenster eine Selektion vor.

3 Wählen Sie File > Bounce to > Disk.

4 Konfigurieren Sie die Bounce-Optionen und -
Einstellungen. 

5 Stellen Sie sicher, dass die Bitauflösung der 
Bounce-Datei der Bitauflösung der Session 
entspricht.

6 Vergewissern Sie sich, dass die Samplerate der 
Bounce-Datei von der Session und dem Audio-
Interface unterstützt wird.

7 Überprüfen Sie gegebenenfalls, ob Dateityp 
und -format der Bounce-Datei dem Dateityp 
und -format der Session entsprechen.

8 Klicken Sie auf Bounce.

Um Bounce-Dateien wieder in die Spuren 
einzufügen, haben Sie folgende Möglichkeiten:

 Aktivieren Sie vor dem Bounce auf Festplatte 
die Import After Bounce-Option. Sobald die 
gebouncten Dateien in die Clipliste importiert 
wurden, können Sie sie per Drag & Drop den 
Spuren zuordnen.

 Importieren Sie die gebouncten Dateien in die 
Session mithilfe des Import Audio-Befehls 
(File > Import > Audio).

 Ziehen Sie die gebouncten Dateien aus einem 
Workspace-Browser oder vom Desktop und 
legen Sie sie ab. 
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Endgültiger Mixdown (mit 
Bounce to Disk)
Beim endgültigen Mixdown erzeugen Sie eine 
Mischung, die alle Editierungen, 
Automationsdaten und Effektbearbeitungen 
enthält.

So bouncen Sie eine endgültige Mischung auf die 
Festplatte:

1 Stellen Sie die Ausgangspegel der 
entsprechenden Spuren ein, vervollständigen 
Sie die Mischautomation für jede Spur in der 
Session.

2 Passen Sie die Einstellungen für die Echtzeit-
Plug-Ins, die Effekte und die Automation für 
jede Spur in der Session an.

3 Stellen Sie sicher, dass alle Spuren, die Sie 
bouncen möchten, hörbar (also nicht 
stummgeschaltet oder deaktiviert) sind.

4 Weisen Sie denselben Ausgangs- oder Buspfad 
allen Spurenausgängen zu, die im Bounce 
enthalten sein sollen.

5 Fügen Sie Dithering hinzu (siehe „Verwenden 
von Dither“ auf Seite 1138).

6 Sie haben folgende Möglichkeiten:

• Wenn Sie die gesamte Session bouncen 
möchten, klicken Sie im Transport-Fenster auf 
„Return to Zero“, um an den Beginn der Session 
zu gelangen. 

• Wenn Sie jedoch nur einen Abschnitt der Session 
bouncen möchten, aktivieren Sie Options > Link 

Timeline and Edit Selection und nehmen Sie im 
Edit-Fenster eine Selektion vor.

7 Wählen Sie File > Bounce to > Disk.

8 Wählen Sie den Quellpfad, den Sie bouncen 
möchten.

9 Konfigurieren Sie je nach Bedarf andere 
Bounce to Disk-Einstellungen. Siehe „Bounce-
Optionen“ auf Seite 1143.

10 Klicken Sie auf Bounce.

Mastering
Beim abschließenden Mastering können Sie direkt 
auf die Festplatte, auf Blu-Ray, DVD oder CD, 
einen Stereo-Mastering- oder auf einen 
Mehrspurrekorder (für Surround-Mischungen) 
aufnehmen.

Wenn Sie einen Master Ihrer Session erzeugt 
haben, können Sie ihn auf ein tragbares Medium 
übertragen, um Kopien davon zu erstellen. Sie 
können die Master-Datei auf CD oder DAT 
überspielen, um sie als Master für die Herstellung 
von CDs zu benutzen.

Mastering auf einen digitalen 
Rekorder
Obwohl es in der Regel am besten ist, Sessions auf 
die Festplatte zu mastern, können Sie mit 
Pro Tools das Mastering direkt auf jedem digitalen 
Rekorder durchführen, der über eine AES/EBU- 
oder S/PDIF-Ausstattung verfügt (etwa einen 
DAT-Rekorder).

Standardmäßig endet der Bounce mit der 
letzten Audiowellenform oder MIDI-Note. 
Wenn Sie möchten, dass der Bounce früher 
endet, treffen Sie eine Edit- oder Timeline-
Selektion, mit der Sie das Ende (und den Start) 
des Bounce definieren.
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Mastering und 
Audiokomprimierung
Obwohl die Audiokomprimierung bei der 
analogen Aufzeichnung oftmals ein 
unverzichtbares Tool darstellt, kann sie 
im digitalen Bereich Probleme verursachen. Beim 
Komprimieren des Eingangssignals mit einem sehr 
hohen Kompressionsverhältnis wird ein Signal 
erzeugt, das, verglichen mit seinen Spitzenwerten, 
über einen wesentlich höheren Gesamtpegel 
verfügt. Wenn Sie einige dieser Signale mit 
höchstmöglichem Pegel auf mehreren Spuren 
aufnehmen, erhöht sich das Risiko, dass es nach 
deren Mischung am Ausgang dieser Signale zu 
einer Übersteuerung kommt.

Wenn stark komprimierte Signale 
zusammengemischt werden, wird ein extrem 
hoher Ausgangspegel erzeugt. Dieser Pegel kann 
den digitalen Vollpegel überschreiten und zu 
Übersteuerungen führen. 

Um diesem Problem entgegenzuwirken, behalten 
Sie den Gesamtpegel Ihres Programmmaterials 
stets gut im Auge. Benutzen Sie die Pegelanzeige 
auf einem Master-Fader oder die Pegelanzeige 
eines externen Mastering-Rekorders, um 
Übersteuerungen zu erkennen. Vermeiden Sie 
beim Mastern auf Festplatte, dass Audiosignale 
mit digitalem Vollpegel mit einem Nullpegel 
(Unity Gain oder 0 db) zusammengemischt 
werden, da dies in jedem Fall eine Übersteuerung 
zur Folge hat.

Mastering und Medien mit 
Fehlerkorrektur
Medien mit Zufallszugriff (etwa Festplatten, oder 
USB-Flashlaufwerke) können eine exakte digitale 
Kopie Ihrer Daten aufzeichnen, da sämtliche Bit-
Informationen erhalten bleiben. Sequenzielle 
Medien (etwa digitale Bänder) arbeiten mit 
Fehlerkorrektur-Systemen, die die unlesbaren 
Daten einer digitalen Übertragung korrigieren. 
Durch diese Korrekturen entsteht eine Abweichung 
vom Original, die bei Kopien über mehrere 
Generationen geringe Klangverluste zur Folge hat.

Sie können diese Verluste vermeiden, indem Sie 
Master-Mischungen auf einem digitalen Medium 
mit Zufallszugriff (etwa eine Festplatte) erstellen 
und die Daten nur bei Bedarf auf ein sequenzielles, 
digitales Medium übertragen.
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Kapitel 47: Surround-Setup

Pro Tools HD ermöglicht die Arbeit mit 
Surroundformaten bis 7.1. 

Surroundmischungen in 
Pro Tools
(Nur Pro Tools HD)

Pro Tools unterstützt Mischungen in den 
folgenden Mehrkanalformaten: LCR, Quad, 
LCRS, 5.0, 5.1, 6.0, 6.1, 7.0, 7.0 SDDS (Sony 
Dynamic Digital Sound), 7.1 und 7.1 SDDS.

Pro Tools-Audioanschlüsse für 
das Mischen im 5.1-Format
Alle 5.1-Mischformate weisen dieselbe 
Lautsprecheranordnung auf; es gibt jedoch drei 
Standardvarianten für die Spurenanordnung der 
einzelnen Kanäle, aus denen eine 5.1-
Mehrkanalmischung besteht. 

In der folgenden Tabelle wird davon ausgegangen, 
dass die Surroundkanäle den Ausgängen 1 bis 
6 eines Pro Tools-Audio-Interfaces zugewiesen 
sind. Die Kanäle 7 und 8 dienen im Falle einer 
Stereoversion zum Abhören der Stereomischung 
oder für Cue-Mischungen. 

Die folgende Tabelle zeigt das Routing für eine 
X-MON-Monospur für eine 7.1 SDDS-
Mischung. Eine 5.1-Mischung sollte dasselbe 
Routing verwenden, jedoch ohne die Ausgänge 
2 und 4 (Lc und Rc).

Weitere Informationen zu den grundlegenden 
Surround-Sound-Konzepten finden Sie im 
Pro Tools-Handbuch „Sync & Surround 
Concepts“.

Spurenanordnungen für 5.1-Surround-Sound

Formate Spurenanordnung

1 2 3 4 5 6

Film 
(Pro Tools-

Stan-
dardein-
stellung)

L C R Ls Rs LFE

SMPTE/
ITU 

für Dolby 
Digital 
(AC3)

L R C LFE Ls Rs

DTS L R Ls Rs C LFE

C|24 L C R Ls Rs Lf

Standard-Spurenanordnung für 7.1 SDDS

Formate Spurenanordnung

1 2 3 4 5 6 7 8

X-MON L Lc C Rc R Ls Rs LFE
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So schließen Sie Audio-Interfaces für das Mischen 
und Abhören von 5.1-Surround-Sound an:

1 Legen Sie das gewünschte 5.1-Format und die 
gewünschte Spurenanordnung fest. 

2 Verbinden Sie die Ausgangskanäle des 
Audio-Interfaces gemäß den in der Tabelle 
oben aufgelisteten Zuweisungen mit den 
entsprechenden Eingangskanälen Ihres 
Monitoring-Systems.

7.1- und 7.0-Formate

7.1- und 7.0-Surround-Sound
HD-DVD- und Blu-Ray-Systeme verwenden 
die folgende Spurenanordnung für 7.1- und 
7.0-Surround-Formate: 

• 3 Kanäle vorne (Links/Left, Mitte/Center, 
Rechts/Right)

• 2 Kanäle seitwärts (Left Surround Side, Right 
Surround Side)

• 2 Kanäle hinten (Left Surround Rear, Right 
Surround Rear)

• 1 LFE-Kanal (nur x.1-Formate)

Die folgende Tabelle zeigt das Monospur-
Standardrouting für eine 7.1-Mischung in 
Pro Tools.

7.1- und 7.0-SDDS-Formate
Die Surround-Formate Sony Dynamic Digital 
Sound (SDDS) 7.1 und 7.0 verwenden die 
folgende Spurenanordnung: 

• 5 Kanäle vorne (Left, Left Center, Center, Right 
Center, Right)

• 2 Kanäle hinten (Left Rear, Right Rear)

• 1 LFE-Kanal (nur x.1-Formate)

Die folgende Tabelle zeigt das Monospur-
Standardrouting für eine 7.1-SDDS-Mischung in 
Pro Tools. 

Weitere Informationen zur Benutzung von 
Bedienoberflächen finden in der jeweils 
mitgelieferten Dokumentation.

Standard-Spurenanordnung für das 7.1-Surround-
Sound

Spurenanordnung

1 2 3 4 5 6 7 8

L C R Lss Rss Lsr Rsr LFE

Standard-Spurenanordnung für das 7.1 SDDS-
Format

Spurenanordnung

1 2 3 4 5 6 7 8

L Lc C Rc R Ls Rs LFE
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Konfigurieren von Pro Tools 
für Mehrkanal-Sessions
Sie können Pro Tools und Sessions auf eine 
beliebige der in diesem Kapitel vorgestellten 
Verfahrensweisen für das Mischen in 
Mehrkanalformaten konfigurieren.

Neue Sessions

Sie können eine neue Session erstellen und eine 
I/O-Einstellungsdatei als Standard-I/O-Setup für 
die Surround-Mischung auswählen. Siehe „Neue 
Sessions und I/O-Einstellungen“ auf Seite 1163. 

Remix von Sessions im Surround-Format 
(Importieren von Mehrkanal-I/O-Setups)

Durch das Erstellen oder Importieren einer I/O-
Einstellungsdatei für Surround-Mischungen im 
I/O Setup-Dialogfeld können Sie Mehrkanalpfade 
in einer beliebigen Stereo-Session (bzw. einer 
Session anderen Formats) verfügbar machen. 
Anschließend können Sie die ursprünglich den 
Stereopfaden zugewiesenen Spuren 
Mehrkanalpfaden zuweisen. Deaktivierte und 
aktivierte Pfade vereinfachen die Neuzuweisung 
Siehe „Importieren von Mehrkanal-I/O-Setups“ 
auf Seite 1165.

Anwenderdefinierte Mehrkanalpfade

Sie können bestehende Pfade im I/O Setup-
Dialogfeld anpassen und neu definieren. Weitere 
Informationen finden Sie unter „Benutzerdefinierte 
Mehrkanalpfade“ auf Seite 1166. 

Importieren von Session-Daten

Mit dem Import Session Data-Befehl (File > Import > 

Session Data) können Sie Spuren und Medien aus 
anderen Sessions sowie die zugehörigen Pfade 
und Spurzuweisungen importieren. Nach dem 
Importieren der Session-Daten konfigurieren Sie im 
I/O Setup-Dialogfeld die Haupt- und Nebenpfade 
entsprechend den Anforderungen der Session. 
Weitere Informationen finden Sie unter Kapitel 7: 
„I/O-Setup“.

Neue Sessions und I/O-
Einstellungen
Sie können beim Erstellen einer neuen Session das 
gewünschte Surround-Format als I/O-Setup 
konfigurieren. In den I/O-Einstellungsdateien 
stehen Standardpfadkonfigurationen für Stereo- 
und Surround-Mischungen zur Verfügung. 

Sobald Sie eine neue Session erstellt haben, 
können Sie Spuren erzeugen und importieren, 
Audiodaten importieren und Signal-Routing für 
die Mischung zuweisen. 

Zur Anzeige von Mehrkanaloptionen in 
Pro Tools muss im Plug-Ins-Ordner das 
Surround Mixer-Plug-In installiert sein. 
Dieses Plug-In kann gemeinsam mit 
Pro Tools installiert werden (siehe das 
Benutzerhandbuch zu Ihrem Pro Tools-
System). Falls das Plug-In nicht installiert 
ist, können Sie es aus dem Ordner „Plug-Ins 
(Unused)“ in den Ordner „Plug-Ins“ 
verschieben.
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So erstellen Sie eine neue Session für das 
Mischen in Mehrkanalformaten:

1 Wählen Sie File > New Session.

2 Wählen Sie die Create Blank Session-Option.

3 Wählen Sie Audio File Type, Sample Rate und 
Bit Depth.

4 Wählen Sie aus dem I/O Settings-Menü eine der 
folgenden Optionen aus: 

• 5.1 Film Mix 

• SMPTE/ITU 

• DTS Monitoring 

• C24 Mix 

• ICON X-MON Mix 

5 Klicken Sie auf OK.

6 Benennen Sie im Save-Dialogfeld die Session, 
navigieren Sie zum Speicherort, an dem die 
neue Session gespeichert werden soll, 
und klicken Sie auf Save.

Gemäß den Voreinstellungen für Surround-
Mischungen wird das I/O Setup-Dialogfeld für die 
neue Session im 5.1-Standardformat mit Haupt- 
und Nebenpfaden für Ausgänge und Busse 
konfiguriert.

Surround Mix-
Einstellungsdateien
Die I/O-Einstellungen für Surround-Mischungen 
enthalten Ausgangs- und Buspfade für sechs 
Standardmäßiger Spurenanordnungen in der neuen 
Session. (Informationen über Eingangs- und 
Insert-Pfade finden Sie unter „Standard-Eingangs- 
und -Insert-Pfade für 5.1-Einstellungen“ auf 
Seite 1165.) 

New Session-Dialogfeld, Auswahl der I/O-Einstellung 
„5.1 Film Mix“

Standardausgangspfade für das 5.1-Format (Film)

Einstellungsdateien und Spurenanordnungen

5.1-Einstellungen Spurenanordnung

5.1 Film Mix L C R Ls Rs LFE

SMPTE/ITU Mix L R C LFE Ls Rs

DTS Mix L R Ls Rs C LFE

C24 Mix L C R Ls Rs Lf

ICON X-MON Mix L Lc C Rc R Ls Rs LFE
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Alle verfügbaren I/O-Einstellungen für Formate 
ab 5.1 (Film, SMPTE/ITU, DTS, C24 Mix oder 
ICON X-MON Mix) stellen folgende Standard-
Ausgangs- und Buspfade für die neue Session bereit:

Standardausgangspfade für 5.1-Formate

• ein Hauptausgangspfad für 5.1-Formate 

• ein Stereo-Hauptausgangspfad

Standardbuspfade für 5.1-Formate

• ein 5.1-Hauptausgangsbuspfad mit 
Nebenpfaden für 5.0 (kein LFE), Links/Rechts 
(Stereo), LCR und Center (Mono) 

• ein Stereo-Hauptausgangsbuspfad mit zwei 
Mono-Nebenpfaden

Standard-Eingangs- und -Insert-Pfade für 
5.1-Einstellungen

Die Einstellungsdateien für 5.1-Mischungen 
enthalten Standard-Stereohauptpfade und 
Standard-Mononebenpfade für Eingänge und 
Inserts. Wenn Sie Mehrkanal-Eingangspfade 

oder -Inserts benötigen, können Sie sie im 
I/O Setup-Dialogfeld erstellen (siehe 
„Benutzerdefinierte Mehrkanalpfade“ auf 
Seite 1166). 

Importieren von Mehrkanal-I/O-
Setups
Im I/O Setup-Dialogfeld können Sie 
Einstellungsdateien importieren und exportieren. 
Dies ist nützlich, wenn Sie eine Stereosession in 
Surround neu mischen möchten. Außerdem 
können Sie diese Funktion zum Vorbereiten einer 
Session für die Übertragung an ein anderes 
Pro Tools-System verwenden oder um I/O-
Einstellungen zu speichern und auszutauschen. 

So importieren Sie eine I/O Setup-Einstellungsdatei:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf die Output-Registerkarte.

3 Klicken Sie auf Import Settings.

4 Wählen Sie die zu importierende 
Einstellungsdatei (.pio) und klicken Sie auf Open.

5 Wenn die Pfaddefinitionen der Session mit 
denen der importierten Einstellungsdatei nicht 
übereinstimmen, werden Sie von Pro Tools 
gefragt, ob Sie die bestehenden 
Pfaddefinitionen löschen möchten oder sie 
beibehalten und die importierten Einstellungen 
Ihrer Session hinzufügen. 

• Klicken Sie auf No, um die neuen Pfade Ihrer 
aktuellen I/O Setup-Konfiguration hinzuzufügen.

• Klicken Sie auf Yes, um Ihre aktuelle I/O Setup-
Konfiguration durch die importierten 
Einstellungen zu ersetzen. 

6 Klicken Sie auf die Bus-Registerkarte.

I/O Setup, Output-Registerkarte, Standard-
Ausgangszuweisungen für 5.1 (Film)

I/O Setup, Bus-Registerkarte, Standard-
Ausgangsbuszuweisungen für 5.1 (Film)
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7 Wenn auf der Bus-Registerkarte nicht die 
richtigen Ausgangsbuszuweisungen für die 
importierte I/O-Einstellungsdatei angezeigt 
werden, klicken Sie auf die Default-Schaltfläche 
(für All Busses oder für Output Busses).

8 Klicken Sie auf OK, um das I/OSetup-
Dialogfeld zu schließen.

Exportieren von I/O-
Einstellungen
Durch Exportieren von Einstellungsdateien für 
I/O-Setups können Sie eine Bibliothek mit 
Mehrkanal-Setups für verschiedene Projekte 
aufbauen. 

So exportieren Sie eine I/O-Einstellungsdatei:

1 Wählen Sie Setup > I/O.

2 Klicken Sie auf Export Settings.

3 Geben Sie einen Namen für die aktuellen I/O-
Einstellungen ein und speichern Sie sie.

Benutzerdefinierte 
Mehrkanalpfade
Im I/O Setup-Dialogfeld können Sie Signalpfade 
für alle unterstützten Mehrkanalmischformate 
erstellen und anpassen. 

Mehrkanalpfade und Nebenpfade werden in der 
Kanalmatrix Eingangs- und Ausgangskanälen 
zugeordnet. Wenn Sie eine bereits konfigurierte 
5.1-I/O-Einstellungsdatei auswählen, entspricht 
die Standardanordnung der jeweiligen für das 
Mehrkanalformat erstellten Pfade der 
Spurenanordnung des gewählten Formats. 

Außerdem enthält das I/O Setup-Dialogfeld 
(wie die Main-Registerkarte des Hardware Setup-
Dialogfelds) Einstellungen zum Routen der 
physischen Ein- und Ausgänge des Audio-Interfaces 
auf die in Pro Tools verfügbaren Ein- und Ausgänge.

Neuzuweisung von Kanälen
Im I/O Setup-Dialogfeld können Sie Kanäle in der 
Kanalmatrix auch neu zuweisen. Dies ist 
besonders nützlich, wenn Sie Kanäle innerhalb 
eines Mehrkanalpfads routen möchten, ohne die 
Verbindung zu den Audio-Interfaces ändern 
zu müssen.

Sie können Pfade gemäß jeder beliebigen 
erforderlichen Konfiguration neu zuweisen. 
Die einzigen Einschränkungen sind Ihre 
Systemressourcen und die Anforderungen im 
I/O Setup-Dialogfeld zur sich überschneidende 
Kanäle und Namen (siehe „Gültige Pfade und 
Voraussetzungen“ auf Seite 95).

Beispiel für ein LCRS-Setup
Das folgende Beispiel zeigt eine mögliche 
Konfiguration des I/O Setup-Dialogfelds für das 
Mischen im LCRS-4-Kanal-Format mit HD 
OMNI.

So definieren Sie einen LCRS-Pfad:

1 Wählen Sie Setup > I/O und klicken Sie auf die 
Output-Registerkarte. 

2 Klicken Sie auf New Path.

3 Wählen Sie über den Path Format-Selektor die 
LCRS-Option aus.

Sie können beim Erstellen von Pfaden im 
5.1-Format die standardmäßige 
Spurenanordnung festlegen. Siehe 
„Standardpfadreihenfolge für 5.1-Spuren“ 
auf Seite 1168. 

Siehe auch „Beispiele für Pfade und Signal-
Routing für Surround-Mischungen“ auf 
Seite 1180. 

Weitere Informationen zum I/O Setup finden 
Sie unter „Ausgangsbusse“ auf Seite 96. 
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4 Geben Sie dem Pfad den Namen „LCRS“.

5 Klicken Sie in der Kanalmatrix auf das Feld 
unterhalb des ersten (am weitesten links 
gelegenen) Audio-Interface-Kanals für den 
Pfad. Pro Tools füllt die rechts davon liegenden, 
benachbarten Einheiten automatisch aus. 
Wenn Sie in der Zeile „LCRS“ unter den Kanal 
1 klicken, wird der LCRS-Pfad über die Kanäle 
1 bis 4 hinweg zugewiesen. 

6 Klicken Sie auf die Bus-Registerkarte.

7 Wenn auf der Bus-Registerkarte nicht die 
richtigen Ausgangsbuszuweisungen für den 
LCRS-Ausgang angezeigt werden, klicken Sie 
auf die Default-Schaltfläche (für All Busses 
oder für Output Busses).

8 Wählen Sie den neuen LCRS-Pfad und klicken Sie 
auf die Reveal Sub-Paths-Dreiecksschaltfläche.

9 Wenn nicht alle Nebenpfade vorhanden sind, 
gehen Sie wie folgt vor:

• Klicken Sie auf New Sub-Path.

• Geben Sie dem neuen Pfad den Namen „LCR“ 
und wählen Sie unter „Path Format“ die LCR-
Option. Klicken Sie in Kanal 1 auf die Zeile 
„LCR“, um den Buspfad zuzuweisen.

• Wählen Sie den LCRS-Pfad aus, klicken Sie auf 
New Sub-Path und erstellen Sie einen Stereo-
Nebenpfad für vorne links und vorne rechts.

• Wählen Sie den LCRS-Pfad aus, klicken Sie auf 
New Sub-Path und erstellen Sie einen Mono-
Nebenpfad für den Center-Kanal.

• Wählen Sie den LCRS-Pfad aus, klicken Sie auf 
New Sub-Path und erstellen Sie einen Mono-
Nebenpfad für den Surround-Kanal.

10 Klicken Sie auf OK, um das I/OSetup-
Dialogfeld zu schließen.

5.1 Spuren, Formate, 
Zuweisungen und Pegelanzeige
Die Pfaddefinitionen im I/O Setup-Dialogfeld 
bestimmen, wie Audio über Ihre Audio-Interfaces 
geroutet und auf ihnen angezeigt wird.

Die internen Pegelanzeigen (am Bildschirm) von 
Pro Tools für Pfade im 5.1-Format entsprechen 
immer der Spurenanordnung für das Filmformat:

L C R Ls Rs LFE

Auch die Spurenanordnung von Pro Tools-
Audiospuren im 5.1-Format im Edit-Fenster 
entspricht der Spurenanordnung des Film-Formats 
(angeordnet von oben nach unten). Siehe „5.1-
Spurenanordnungen, Routing und Pegelanzeigen“ 
auf Seite 1169.

Sie können diese Signale im I/O Setup-Dialogfeld 
entsprechend jeder beliebigen Spurenanordnung 
(etwa DTS oder SMPTE/ITU) aus Ihren Audio-
Interfaces routen. 

So weisen Sie Kanäle in einem Pfad neu zu:

 Ziehen Sie einen Kanal an eine neue zulässige 
Position im Raster. Andere Kanalzuweisungen 
werden dabei verschoben, um den eingefügten 
Kanälen Platz zu machen.

Output-Registerkarte, LCRS-Ausgangspfad

Bus-Registerkarte, LCRS-Ausgangsbus mit 
Nebenpfaden
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Standardeinstellungen für 
Selektoren im I/O Setup-
Dialogfeld
Die Output-Seite des I/O Setup-Dialogfelds 
enthält Auswahlelemente (Selektoren) zum 
Einrichten von I/O-Standardeinstellungen für Ihre 
Mehrkanal-Sessions.

Default Monitor Format – legen Sie das 
Standardformat für Monitore (Stereo, 5.1 oder 7.1) 
für neue Ausgangspfade und für die Belegung der 
Default-Schaltfläche fest.

5.1 Path Order – hier wählen Sie die Standard-
Spurenanordnung (bzw. Pfadreihenfolge) für alle 
neuen (6-Kanal-)Ausgangspfade im 5.1-Format aus.

Output Meter Path – hier wählen Sie den Pfad aus, 
der in den Ausgangspegelanzeigen von 
Bedienoberflächen erscheint. Weitere Hinweise 
finden Sie unter „5.1 Spuren, Formate, 
Zuweisungen und Pegelanzeige“ auf Seite 1167.

Abhörpfade – hier wählen Sie den Monitor-Pfad 
für das Abhören von Audiodaten in der Clipliste, 
in Import Audio-Dialogfeldern und im Workspace-
Browser aus. Es können nur Ausgänge des primären 
Interfaces für den Abhörpfad verwendet werden.

Standardausgangsbus – hier wählen Sie den 
standardmäßigen Bus-Ausgangspfad für alle neuen 
Spuren in jedem unterstützten Spurformat aus.

AFL/PFL Path (nur Pro Tools|HDX- und 
Pro Tools|HD Native-Systeme) – hier bestimmen 
Sie, wohin die Spuren geroutet werden, wenn sie 
im Solo-Modus für AFL (After Fader Listen) oder 
PFL (Pre Fader Listen) sologeschaltet sind.

AFL/PFL Mutes (Output Path, nur Pro Tools|HDX- 
und Pro Tools|HD Native-Systeme) – hier 
bestimmen Sie, welcher Ausgang 
stummgeschaltet wird, wenn der Solo-Modus für 
AFL (After Fader Listen) oder PFL (Pre Fader 
Listen) aktiviert und eine Spur sologeschaltet ist.

Standardpfadreihenfolge für 
5.1-Spuren
Sie können für alle von Ihnen im 5.1-Format neu 
erstellten Pfade Standard-Spurenanordnungen 
festlegen.

So wählen Sie eine neue Standardanordnung für 
5.1-Format-Pfade (Spuren):

1 Wählen Sie Setup > I/O. 

2 Klicken Sie auf die Output-Registerkarte.

3 Verwenden Sie die 5.1 Default Path Order-
Einstellung zur Auswahl der Spurenanordnung 
(Film, SMPTE/ITU oder DTS Monitoring). 

Standard-Selektoren im I/O Setup-Dialogfeld

5.1-Standardpfadanordnung I/O Setup-Optionen

Sie können „New Track Default Output“ auf 
Bus- und Ausgangspfade einstellen.
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5.1-Spurenanordnungen, Routing und Pegelanzeigen

Spurenanordnungen für verschiedene 5.1-Formate

L C R Ls Rs LFE

5.1-Format Spuren Spurpegelanzeigen Kanalzuweisungen im I/O Setup-Dialogfeld

L R C LFE Ls Rs

L R Ls Rs C LFE

L x C x R Ls Rs LFE

L C R Ls Rs LFE

identisch
L C R Ls Rs LFE 
(von links nach 

rechts)

identisch

L C R Ls Rs LFE 
(von oben nach 

unten)

identisch identisch

identisch identisch

L C R Ls Rs LFE L C R Ls Rs LFE

L C R Ls Rs LFE L C R Ls Rs LFE
(von oben 

nach unten)
(von links nach 

rechts)

Film (Pro Tools-
Standard und C|24 Mix) 
L C R Ls Rs LFE

SMPTE/ITU 
(Control|24 Mix) 
L R C LFE Ls Rs

DTS
L R Ls Rs C LFE

ICON X-MON 
(8-Kanal 7.1) 
L x C x R Ls Rs LFE
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Kapitel 48: Mehrkanalspuren und Signal-
Routing

Surround-Sessions enthalten normalerweise eine 
Kombination aus Mono-, Stereo- und Mehrkanal-
Audio, Auxiliary-Eingangs-, Master-Fader- und 
Instrumentenspuren sowie Bussen und Inserts.

Nachdem Sie das entsprechende I/O-Setup 
importiert oder konfiguriert haben, können Sie 
mithilfe der Mischfunktionen von Pro Tools 
beliebige Audio-, Master-Fader- und 
Instrumentenspuren in Mehrkanal-Surround-
Formaten mischen. 

Die I/O-Einstellungen für Mehrkanalmischungen 
und Signal-Routing werden durch die im I/O-
Setup-Dialogfeld definierten Pfade bestimmt.

Mehrkanal-Audiospuren
(Nur Pro Tools HD)

Mehrkanal-Audiospuren enthalten für jedes Signal 
in der Spur einen eigenen Kanal. Eine 5.1-Spur 
verfügt beispielsweise über 6 Kanäle, und zwar 
je einen für Links, Rechts, Center, Surround links, 
Surround rechts und LFE. 

Bei Mehrkanal-Audiospuren stehen Ihnen 
folgende Funktionen zur Verfügung:

• Aufnahme über mehrere Mikrofone oder 
Mikrofon-Arrays direkt in Pro Tools oder routen 
auf die entsprechenden Mehrkanal-
Eingangspfade in Pro Tools

• importieren aus anderen Pro Tools-Sessions

• editieren, bearbeiten und mischen in 
Kombination mit Mono- und Stereospuren

Audiodateien und Audiospuren im 5.1-Format 
entsprechen der Standardspuranordnung für Film. 
Unabhängig von den Pfadzuweisungen im 
I/O Setup-Dialogfeld entsprechen alle Audiospuren 
und -Anzeigen im 5.1-Format folgender 
standardmäßigen Spuranordnung für Film:

L C R Ls Rs LFE 

Mehrkanal-Surround-Mischungen sind nur 
in Pro Tools HD möglich.

Mehrkanal-Audiospur im 5.1-Format
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Mehrkanal-Audiospuren müssen nicht 
notwendigerweise in Mehrkanalformaten 
gemischt werden. Mono-, Stereo- und alle 
unterstützten Spurenformate können unter 
Verwendung der Pro Tools-Spurausgänge und 
Sends gemischt werden (siehe „Mehrkanal-
Signalrouting“ auf Seite 1174).

Platzieren von Audiomaterial in 
Mehrkanalspuren
Sie können Audiodateien und -clips aus 
Workspace-Browsern, der Clipliste, Windows 
Explorer, Mac Finder oder aus anderen Spuren 
ziehen und in Mehrkanal-Audiospuren platzieren.

Die Anzahl der auf diese Weise übertragenen 
Kanäle muss dazu dem Format der Zielspuren 
entsprechen. So können Sie etwa nur ein Stereopaar 
oder zwei Monoclips auf eine Stereo-Audiospur 
ziehen. Analog dazu können Sie Audio nur dann 
in einer LCR-Spur platzieren, wenn Sie drei Clips 
ausgewählt haben. Bei Spuren im 5.1-Format 
müssen Sie sechs Monodateien oder -clips 
selektieren.

Solo, Mute und Gain in 
Mehrkanalspuren und -pfaden
Stereo- und Mehrkanalspuren bestehen aus 
mehreren miteinander gekoppelten Audiosignalen. 
Standardmäßig werden Mehrkanalspuren über 
jeweils einen einzigen Kanalfader und Solo- und 
Mute-Schalter gekoppelt und gesteuert. 

Um Signale einzeln steuern zu können, müssen Sie 
Mehrkanalspuren in einzelne Monospuren 
umwandeln. Um Pegel und Phasen gesondert 
anzupassen, können Sie ein Multimono-Trim-
Plug-In einfügen und die Koppelung aufheben. 
Beide Vorgehensweisen werden weiter unten 
beschrieben.

So konvertieren Sie eine Mehrkanalspur in 
separate Monospuren:

1 Wählen Sie die Mehrkanalspur aus.

2 Wählen Sie „Track > Split Into Mono“. 

So regeln Sie den Gain gesondert für einzelne 
Kanäle einer Mehrkanalspur: 

1 Fügen Sie ein Multimono-Trim-Plug-In in die 
Mehrkanalspur ein.

2 Heben Sie die Koppelung für das Trim-Plug-In 
auf. Klicken Sie dazu auf das Link-Symbol, 
sodass es nicht mehr leuchtet. 

In Mehrkanalspuren gezogene Audiodateien 
werden von oben nach unten in genau der 
Reihenfolge platziert, in der sie in ihrer 
ursprünglichen Clipliste oder Playlist 
erscheinen (im Menü „Clip List > Timeline 
Drop Order“ muss „Top to Bottom“ 
ausgewählt sein). Aus diesem Grund 
empfiehlt es sich, Audiodateien vor dem 
Ziehen mit der Maus umzubenennen, um sie 
in die gewünschte Reihenfolge zu bringen. 
Benennen Sie die Dateien also so um, dass 
sie beim alphabetischen Sortieren mit dem 
By Clip Name-Befehl in der Clipliste in die 
gewünschte Reihenfolge gebracht werden. 
Beispiel: Bei einer Spur im 5.1-Format 
können Sie die Audiospuren so umbenennen, 
dass die Anordnung der Spuren den Kürzeln 
L, C, R, Ls, Rs und LFE entspricht.

Wenn Sie Mehrkanalspuren in Monospuren 
umgewandelt haben, können diese nicht 
wieder in ihrem ursprünglichem 
Mehrkanalformat erneut gekoppelt werden. 
Eine Mehrkanalspur kann jedoch 
zusammengefasst werden, indem Sie die 
entsprechende Anzahl von Monodateien 
(mit den zugehörigen Dateiendungen) in eine 
Mehrkanalspur ziehen; dabei können jedoch 
einige Automationsdaten verloren gehen. 
Sie können aber auch den Submix der 
Monospuren in einer Mehrkanalspur auf der 
Festplatte aufnehmen.
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3 Zeigen Sie mithilfe des Channel-Selektors die 
Steuerelemente eines Kanals an und passen Sie 
den Gain an. 

Spur- und Ausgangsformate
Beim Erstellen neuer Spuren legen Sie ein Format 
fest: Mono, Stereo oder eines der unterstützten 
Mehrkanalformate. 

Sie erkennen das Spurformat eines Spurausgangs 
in den Mix- und Edit-Fenstern immer anhand der 
Anzahl der Pegelanzeigen neben dem Fader: eine 
Anzeige bei Monospuren, zwei bei Stereospuren, 
sechs bei 5.1-Spuren usw.

Wenn Sie einer Spur einen Ausgang zuweisen, 
bestimmen Sie damit das Format dieses Ausgangs. 
Eine Monospur hat beispielsweise immer eine 
einzelne Spurpegelanzeige, selbst wenn sie einem 
Stereoausgangspfad zugewiesen ist. Wird eben 
diese Monospur nun einem 5.1-Ausgangspfad 
zugewiesen, wird sein Ausgangssignal zwischen 
diesen sechs Ausgangskanälen abhängig von der 
Position des Panners verteilt. 

Ändern des Formats

Wenn Sie das Ausgangsformat für eine bestimmte 
Spur ändern, hat dies verschiedene Auswirkungen:

• Der Panner in dieser Spur ändert sich 
entsprechend dem neuen Ausgangsformat.

• Möglicherweise müssen eine oder mehrere 
Automations-Playlists, die mit dem Panner in 
Zusammenhang stehen, erstellt oder gelöscht 
werden.

Da eine Änderung des Ausgangsformats die oben 
beschriebenen Auswirkungen hat, erscheint eine 
Warnmeldung, wenn Sie das Ausgangsformat 
einer Spur in ein Format mit weniger Kanälen 
ändern. Dies ist vor allem dann der Fall, wenn 
dadurch Automations-Playlists gelöscht 
werden müssen.

Mehrfache Ausgangs- und 
Spurformatzuweisungen

Wenn eine Spur mehreren Pfaden mit 
unterschiedlichen Formaten zugewiesen ist, richtet 
sich der Hauptausgang dieser Spur nach dem 
Format, das die meisten Kanäle aufweist.

Mehrere Ausgänge und Automations-Playlists

Wenn einer Spur mehrere Ausgänge zugewiesen 
sind, ordnet Pro Tools die Panning-Daten den 
entsprechenden Pfaden zu. Wenn Sie 
beispielsweise eine Monospur gleichzeitig einem 
Stereopfad und einem 5.1-Pfad zuweisen, 
ist für diese Spur im Mix- bzw. Edit-Fenster ein 
5.1-Panner zu sehen. Beim Pannen der Spur 
interpretiert Pro Tools die 5.1-Panning-Verläufe 
als Stereo-Pan-Verschiebungen. 

Dadurch können Sie Mischungen parallel 
vornehmen. Sie können gleichzeitig verschiedene 
Mischungen für unterschiedliche Formate 
vornehmen, indem Sie die entsprechenden 
Elemente auf mehrere Pfade routen. 

Weitere Hinweise finden Sie unter „Koppeln 
der Steuerelemente von Multimono-Plug-Ins 
und Aufheben der Koppelung“ auf 
Seite 1176. 

Klicken Sie bei gedrückter Strg- und 
Starttaste (Windows) bzw. Ctrl- und 
Befehlstaste (Mac) auf eine Einstellung in 
einem Output-Fenster, um im Edit-Fenster 
die zugehörige Automations-Playlist und 
Pan-Automation anzuzeigen. 
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Mehrkanal-Signalrouting
Für das Mischen in einem Mehrkanalformat 
werden Spuren Mehrkanalpfaden zugewiesen. 

Sie können Spuren mithilfe der folgenden 
Methoden im Surround-Format mischen:

• Zuweisen des Hauptausgangs einer Spur an 
einen Mehrkanalpfad 

• Zuweisen eines Mehrkanal-Sends zum Routen 
des Audiosignals auf einen Mehrkanalpfad 

Mehrkanalspuren-Ausgänge
Mithilfe des Output Path-Selektors können Spuren 
auf Mehrkanalausgangs- oder Buspfade geroutet 
werden. Dadurch steht Ihnen im I/O-Bedienfeld 
des Mix- und Edit-Fensters ein Mehrkanal-Panner 
und eine Mehrkanal-Pegelanzeige zur Verfügung. 

Sie können weitere Ausgangszuweisungen 
hinzufügen, indem Sie bei gedrückter Windows-
Taste (Windows) bzw. Ctrl-Taste (Mac) auf das 
Selector-Tool klicken und einen weiteren Pfad 
zuweisen. 

Zwei Möglichkeiten für das Konfigurieren von Spuren 
für Mehrkanalmischungen

Mehrkanal-
Ausgangspfad

Mehrkanal-Send



Kapitel 48: Mehrkanalspuren und Signal-Routing 1175

Mehrkanal-Sends
Sie können Mono-, Stereo- und allen anderen 
Spurenformaten einen oder mehrere Mehrkanal-
Sends zuweisen. Dadurch steht Ihnen in der Sends-
Ansicht ein Mehrkanal-Panner zur Verfügung. 
Sends sind auch nützlich, um Spuren für die 
Verarbeitung mit Mehrkanal-Plug-Ins 
zusammenzufassen. 

Die folgende Abbildung zeigt eine Mono-
Audiospur mit einem 5.1-Send (6-Kanal) (View > 
Sends A–E > Send A).

Die Pro Tools-Bus- und Submix-Funktionen 
stehen bei allen Kanalformaten, von Mono über 
Stereo bis 8-Kanal, zur Verfügung. Beispiele für 
Mehrkanalmonitoring, Effektverarbeitung und 
Busfunktionen finden Sie unter „Mischen mit 
Haupt- und Nebenpfaden“ auf Seite 1177. 
Beispiele zu Mono- und Stereomischungen finden 
Sie unter Kapitel 43: „Einfaches Mixen“. 

Mehrkanal-Auxiliary-Eingänge 
und Master-Fader
Ein Mehrkanal-Auxiliary-Eingang oder Master-
Fader wird als Return für den Mehrkanalbus 
verwendet. Sends eignen sich zum gleichzeitigen 
Erstellen einer zusätzlichen, unabhängigen 
Mischung (eventuell in einem bestimmten Format), 
für die eigene Fader sowie Steuerelemente für 
Stummschaltung, Solo-Schaltung und Automation 
benötigt werden.

Master-Fader können Haupt- und Nebenpfaden 
zugewiesen werden. Die Hauptpfade müssen dem 
Format des Master-Faders entsprechen. Es kann 
immer nur ein Master-Fader aktiv sein und einem 
einzelnen (aktiven) Haupt- oder Nebenpfad 
zugewiesen sein. Ein Master-Fader kann einem 
Nebenpfad nicht zugewiesen werden, wenn der 
dazugehörige Hauptpfad bereits einem anderen 
Master-Fader zugewiesen wurde. Siehe „Master-
Fader-Spuren und Signalfluss“ auf Seite 982. 

Mehrkanal-Instrumentenspuren
Sie können Mehrkanalspuren zum Abhören und 
Routen von Mehrkanal-Instrumenten-Plug-Ins 
oder externen Multikanal-MIDI-Instrumenten 
verwenden.

Mono-Audiospur mit Mono-Ausgangsformat und 
Mehrkanal-Send

Mehrkanal-Send-Panner

Monopegelanzeige

Monoausgangsformat
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Mono-, Multimono- und 
Mehrkanal-Plug-Ins
Plug-Ins finden bei Mono-, Multimono- oder 
Mehrkanalformaten Anwendung.

Informationen über Mono-, Stereo- und Mono-In-
/Stereo-Out-Plug-Ins finden Sie unter Kapitel 44: 
„Plug-In- und Hardware-Inserts“.

Multimono-Plug-Ins sind für Stereo- und 
Mehrkanalspuren ausgelegt. Multimono-Plug-Ins 
sind in den folgenden Situationen nützlich bzw. 
erforderlich: 

• wenn ein Plug-In keine Verarbeitung im 
Zusammenhang mit Mehrkanalformaten bietet 
(etwa wenn auf ausgewählte Elemente eines 
Mehrkanalsignals ein EQ angewendet 
werden soll)

• wenn Sie Signale innerhalb von 
Mehrkanalspuren separat bearbeiten müssen

• wenn ein Plug-In keine Mehrkanalformate 
unterstützt

Wird ein Multimono-Plug-In zum ersten Mal in 
eine Mehrkanalspur eingefügt, werden die Plug-
In-Steuerelemente gekoppelt. Sie können diese 
Koppelung jedoch aufheben, um individuelle 
Anpassungen vornehmen zu können. Weitere 
Hinweise finden Sie unter „Koppeln der 
Steuerelemente von Multimono-Plug-Ins und 
Aufheben der Koppelung“ auf Seite 1176.

Multimono-Plug-Ins können auch in Stereospuren 
eingefügt werden, um nicht gekoppelte Plug-Ins 
auf den linken und rechten Kanal anzuwenden.

Mehrkanal-Plug-Ins sind für Stereo- und 
Mehrkanalspuren ausgelegt, bei denen 
entsprechende Bearbeitungsprozesse 
erforderlich sind (etwa Stereo- und 
Mehrkanal-Limiting, -kompression und 
ähnliche Effekte). 

Koppeln der Steuerelemente 
von Multimono-Plug-Ins und 
Aufheben der Koppelung
Wenn ein Multimono-Plug-In auf einer 
Mehrkanalspur mit mehr als zwei Kanälen 
verwendet wird, werden die Steuerelemente 
normalerweise gekoppelt. Wenn dann etwa das 
Gain-Steuerelement auf einem Kanal verschoben 
wird, wird es gleichzeitig für alle anderen Kanäle 
eingestellt.

Bei Bedarf können Sie die Koppelung von Plug-
In-Steuerelementen auf bestimmten Kanälen einer 
Spur aufheben und die Plug-Ins unabhängig 
voneinander bearbeiten. Sie können auch die 
Steuerelemente bestimmter Kanäle selektiv 
koppeln. 

Um beispielsweise gleiche Filtergrenzfrequenzen 
auf Ls- und Rs-Kanal (Surround) in einer 5.1-
Mischung anzuwenden, können Sie nur diese 
Kanäle in einem ungekoppelten Multimono-EQ-
Plug-In für eine Koppelung aktivieren. Wenn Sie 
die Steuerelemente im Plug-In-Fenster für einen 
der Kanäle (Ls oder Rs) anpassen, wird auch der 
andere, gekoppelte Kanal angepasst. 

Channel-Selektor – dieser bietet Zugriff auf 
bestimmte Kanäle innerhalb einer Mehrkanalspur, 
in dem Plug-In-Parameter bearbeitet werden 
können. Dieses Popup-Menü erscheint lediglich 
auf Multimono-Plug-Ins, die auf Spuren mit mehr 
als zwei Kanälen eingeschleift wurden. 

Channel-Selektor und Link-Schaltflächen

Channel-Selektor

Link Enable-Schaltflächen

Master-Link-Schaltfläche
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Master-Link-Schaltfläche – diese koppelt die 
Parametersteuerelemente aller Kanäle eines 
Multimono-Plug-Ins, sodass sie gemeinsam 
eingestellt werden können.

Link Enable-Schaltflächen – diese Schaltflächen 
ermöglichen die selektive Koppelung der 
Parametersteuerelemente einzelner Kanäle eines 
Multimono-Plug-Ins. Jedes Quadrat steht für einen 
Lautsprecherkanal. Die Master Link-Schaltfläche 
muss deaktiviert sein, damit Sie die Link Enable-
Schaltflächen verwenden können. 

So entkoppeln Sie Steuerelemente in einem 
Multimono-Plug-In:

 Deaktivieren Sie die Master Link-Schaltfläche. 
Sie leuchtet, wenn die Koppelung aktiv ist, 
und leuchtet nicht, wenn die Koppelung 
aufgehoben ist.

So greifen Sie auf Steuerelemente für einen 
bestimmten Kanal zu:

 Wählen Sie über den Channel-Selektor den 
gewünschten Kanal aus.

So öffnen Sie ein Plug-In-Fenster für alle Kanäle 
eines Multimono-Plug-Ins:

 Klicken Sie bei gedrückter Alt- (Windows) bzw. 
Wahltaste (Mac) auf den Channel-Selektor.

So koppeln Sie die Steuerelemente bestimmter 
Kanäle:

1 Deaktivieren Sie die Master Link-Schaltfläche, 
sofern Sie das nicht bereits getan haben.

2 Klicken Sie auf die Link Enable-Schaltflächen 
für die Kanäle, deren Steuerelemente Sie 
koppeln möchten.

Pfade in Surround-
Mischungen
Da Pro Tools eine flexible Umgebung für das 
Routen und Submixen bietet, können Sie Ihre 
verfügbaren Systemressourcen maximieren, 
indem Sie zuerst nur die Elemente ermitteln, 
die Sie dynamisch pannen möchten, sowie 
diejenigen, die nur in bestimmten Kanäle platziert 
werden können (siehe „Mischen mit Haupt- und 
Nebenpfaden“ auf Seite 1177).

Sobald Sie diese Elemente in Ihrer Session 
identifiziert haben, können Sie eine Kombination 
von Haupt- und Nebenpfad-Zuweisungen sowie 
Mehrkanal-Panning verwenden.

Mischen mit Haupt- und 
Nebenpfaden
Es kommt nur selten vor, dass eine Spur zwischen 
mehreren Lautsprecherpaaren gepannt werden 
muss. In den meisten Fällen werden bestimmte 
Elemente auf bestimmte Lautsprecher gelegt, 
bleiben dort und bilden so die Basis für eine 
Mischung.

In der folgenden Abbildung sehen Sie ein Beispiel 
für eine Kombination von Panning und Signal-
Routing in einer Mehrkanalmischung. 

Weitere Informationen finden Sie unter 
„Anwenden der Konventionen für 
Stereomischungen auf Surround-
Mischungen“ auf Seite 1182. 
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Wann sollten Mehrkanalausgänge zugewiesen 
werden?

 Weisen Sie 5.1-Pfade nur den Spuren zu, die auf 
alle sechs Kanäle gepannt werden müssen. 

Eine Spur für Soundeffekte eines Düsenjets sollte 
beispielsweise einem 5.1-Pfad zugewiesen 
werden, damit das Flugzeuggeräusch von den 
vorderen an die hinteren Lautsprecher 
weitergegeben werden kann. Sie können in einer 
Musikmischung ein Soloinstrument in einem 
anderen Lautsprecher erklingen oder ein 
Synthesizer-Pad als Spezialeffekt durch den Raum 
wirbeln lassen. 

Elemente, die gleichzeitig auf allen Lautsprechern 
zu hören sein sollen, können ebenfalls einem 
Mehrkanalausgang zugewiesen werden – 
unabhängig davon, ob sie im Schallfeld aktiv 
gepannt werden müssen oder nicht. 

Anwendungsbereich von Nebenpfaden 

 Um umfangreiche Sessions möglichst einfach 
zu gestalten, solltenNebenpfade zum Routen 
statischer (oder stationäre) Elemente direkt auf 
den oder die Ausgangskanäle eingesetzt 
werden. 

Filmdialog wird beispielsweise oft auf den Center-
Kanal gemischt, um dieses wichtige Audio-
Element am Bild zu verankern zu können. Anstatt 
eine Dialogspur einem Sechs-Kanal-Panner 
zuzuweisen und die Spur nur auf den Center-
Lautsprecher zu pannen, können Sie den 
Hauptausgang einer Dialogspur auch auf einen 
Mono-Nebenpfad (Center) routen.
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Signal-Routing und Nebenpfade beim Mischen in Surround-Formaten

Effektbus-
Routing

Ausgänge
auf
Nebenpfade

Ausgänge auf Hauptpfad für 5.1-Surround-Panning

Spuren geroutet auf Nebenpfade Spuren auf Main-Path 
für 5.1-Surround-Format 
geroutet

Auxiliary-Eingang
auf Nebenpfad für
5.0-Surround-
Format geroutet
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Anwenden der Konventionen für 
Stereomischungen auf 
Surround-Mischungen
Stereomischungen geben die Richtlinien für 
aktives und statisches Pannen vor. Dieselben 
Grundsätze lassen sich auch auf Surround-
Mischungen anwenden. 

Das Hin- und Herpannen eines Klangs zwischen 
dem linken und rechten Lautsprecher eignet sich 
am besten als Spezialeffekt. In einer typischen 
Musikmischung werden die Basisspuren im 
Stereofeld platziert und bleiben dort. 

Wenn zu viele Elemente ständig verschoben 
werden, können Surround-Mischungen inkohärent 
klingen. Als Spezialeffekt können Sie einige 
Spuren dynamisch pannen und sie zwischen 
Lautsprechern hin- und herspringen oder von einer 
Seite zur anderen wandern lassen.

Beispiele für Pfade und 
Signal-Routing für Surround-
Mischungen
Das Schlüsselelement in jeder Pro Tools-
Surround-Session ist das Signal-Routing. 
Das Signal-Routing wird im I/O Setup-Dialogfeld 
konfiguriert.

In den folgenden Beispielen sehen Sie, wie 
Auxiliary-Eingänge, Master-Fader und andere 
Signal-Routing-Funktionen von Pro Tools für 
Stem-Mischungen, Submixe und Ähnliches 
verwendet werden können. 

In diesen Beispielen werden Musik und Effekte für 
einen Kinovorspann im 5.1-Surround-Format 
gemischt. Separate Stem-Mischungen (für Musik 
und für Effekte) sollen auf einen 8-Spur-MDM 
übertragen werden.

Beispiele für Ausgangspfade
Die folgende Abbildung zeigt die für eine 
Beispiel-Session im I/O Setup-Dialogfeld 
definierten Ausgangspfade; die betreffende 
Session wurde auf einem Pro Tools|HDX-System 
mit einem HD OMNI-Audio-Interface erstellt.

Für Mix, FX, Dialog und Musik wurden 
verschiedene Nebenpfade definiert.

Beispiele für Buspfade
Die folgende Abbildung zeigt Beispiele für 
Buspfade.

Es wurden ein LCR-Pfad („Dialog“), ein 
Stereopfad („Music“) und ein 5.1-Formatpfad 
(„FX“) definiert, von denen jeder über mehrere 
Nebenpfade verfügt.

I/O-Setup, Beispiele für Ausgangspfade

I/O-Setup, Beispiele für Buspfade
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Beispiele für Nebenpfade
Mithilfe von Nebenpfaden können Sie bestimmte 
Kanäle eines Mehrkanalsignals (Surround-Sound) 
auswählen. In der folgenden Abbildung sehen Sie 
dies anhand des Surround-Busses, der über 
mehrere Nebenpfade verfügt. 

LCR-Nebenpfad – der Nebenpfad für die vorderen 
drei Kanäle. Diesen Nebenpfad nutzen Sie am 
besten, um Dialog oder andere vorwärts gerichtete 
Soundeffekte zu mischen. 

Stereo-Nebenpfad – der vordere Stereo-
Nebenpfad. Diesen Nebenpfad nutzen Sie am 
besten, um Musik-Stems oder Effekte für den 
rechten und linken vorderen Lautsprecher 
zu mischen. 

Center-Nebenpfad – der Nebenpfad für vorne 
Center, der einen separaten Monopfad für den 
Center-Kanal bereitstellt.

Ls/Rs-Nebenpfad – der Surround-Nebenpfad für 
rechts und links hinten. Diesen Nebenpfad nutzen 
Sie am besten, um Surroundeffekte zu mischen. 

LFE-Pfad – der LFE-Nebenpfad ist ein gesonderter 
Monopfad für den LFE-Kanal. 

5.0-Nebenpfad – der 5.0-Nebenpfad ist ein 
Nebenpfad mit 5 Kanälen. Verwenden Sie 
diese Art von Nebenpfad-Routing für Spuren, 
die keinesfalls in den LFE-Kanal aufgenommen 
werden sollen. Dadurch können Sie Ressourcen 
für das Mischen freihalten.

I/O-Setup, Beispiel für Nebenpfade
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Beispiele für Signal-Routing
Im Folgenden werden anhand einer Beispiel-
Session, bestehend aus einer 5.1-Hauptmischung 
mit Musik- und Effekt-Stems (oder Submixen), 
einige mögliche Varianten für die Verwendung 
von Haupt- und Nebenpfaden gezeigt. 

Bespiele für Submix-Stems

Die folgende Abbildung zeigt eine Routing-
Konfiguration für einen Effekt-Submix. Dabei 
werden zwei Spuren auf Stereobus-Nebenpfade 
geroutet, während andere einem LCR- und einem 
Monobus-Nebenpfad zugewiesen werden. Zwei 
Spuren (eine Mono- und eine Stereospur) werden 
Mehrkanalbussen für das Surround-Panning 
zugewiesen. Ein dem FX-Hauptbuspfad 
zugeordneter 5.1-Auxiliary-Eingang dient als 
Submixer. 

Anwenden der Konventionen für 
Stereomischungen auf Surround-Mischungen

Stereomischungen geben die Richtlinien für 
aktives und statisches Pannen vor. Dieselben 
Grundsätze lassen sich auch auf Surround-
Mischungen anwenden. 

Das Hin- und Herpannen eines Klangs zwischen 
dem linken und rechten Lautsprecher eignet sich 
am besten als Spezialeffekt. In einer typischen 
Musikmischung werden die Basisspuren im 
Stereofeld platziert und bleiben dort. 

Wenn zu viele Elemente ständig verschoben 
werden, können Surround-Mischungen inkohärent 
klingen. Als Spezialeffekt können Sie einige 
Spuren dynamisch pannen und sie zwischen 
Lautsprechern hin- und herspringen oder von einer 
Seite zur anderen wandern lassen.

FX-Stem
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Die folgende Abbildung zeigt eine Routing-Konfiguration für Musikspuren.

Die meisten Musikspuren in diesem Beispiel 
werden über einen Stereo-Nebenpfad auf den 
vorderen linken bzw. rechten Kanal geroutet. 
Ein 5.1-Auxiliary-Eingang steuert die Bus- und 
Stem-Ausgabe. 

Mehrfache Ausgangszuweisungen

Sie können mittels mehrfacher 
Ausgangszuweisungen eine Reihe von 
Mischungen in mehreren Formaten konfigurieren. 
So können Sie Spuren etwa einen zusätzlichen 
Stereoausgang zuweisen und parallel zur 5.1-
Mischung eine Stereomischung erstellen. Weitere 
Informationen finden Sie unter „Mehrfache 
Ausgangszuweisungen“ auf Seite 996.

Beispiele für LFE
Sie können LFE-Spuren und anderes 
Audiomaterial auf zwei Arten zur LFE-Spur 
zumischen:

• mit dem LFE-Fader in einem Output-Fenster; 
in diesem Fall ist das LFE-Signal Post-Fader. 

• über einen anwenderdefinierten Nebenpfad zum 
separaten Routen von Kanälen.

Musik-Stem



Pro Tools-Referenzhandbuch1184

Die nachfolgende Abbildung zeigt ein Output-
Fenster, das Signale an den LFE-Kanal sendet und 
seinen Pegel anzeigt. 

Mit dem LFE-Fader können Sie der gesamten 
LFE-Ausgabe einen beliebigen Pegelanteil eines 
beliebigen Mehrkanalpfads hinzufügen. 
Im Beispiel oben wurde der Center-Anteil der 
Spur ausgeschaltet und der LFE-Fader nach oben 
verschoben, um das Signal auf den LFE-Kanal 
zu routen. 

Die nachstehende Abbildung zeigt, wie eine 
herkömmliche LFE-Spur ausschließlich auf den 
LFE-Kanal geroutet werden kann. In diesem 
Beispiel wird ein anwenderdefinierter LFE-
Nebenpfad des FX-Busses verwendet. 

LFE und Filtern
In Pro Tools werden LFE-Signale nicht gefiltert. 
Für einige Anforderungen sind eventuell Filter für 
die LFE-Spur erforderlich.

LFE-Fader

Separates LFE-Routing mit Hauptausgang auf dem 
Mono-LFE-Kanal

LFE-Fader können sich nach Mix- und Edit-
Gruppen richten. Informationen dazu finden 
Sie unter „Auswählen von 
Gruppenattributen“ auf Seite 265.

Informationen zur Erstellung eines 
Nebenpfades finden Sie unter 
„Benutzerdefinierte Mehrkanalpfade“ auf 
Seite 1166. 
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Kapitel 49: Pannen und Mischen im 
Surround-Format

Vor dem Pannen einer Spur in Surround muss die 
Spur dem entsprechenden Mehrkanalausgang oder 
Buspfad zugewiesen werden. 

Sie können die Bus- und Ausgangsarchitektur des 
Pro Tools-Mehrkanal-Surround-Mixers im 
I/O Setup-Dialogfeld definieren. Bevor Sie mit 
Pro Tools-Mehrkanalprojekten zu arbeiten 
beginnen, sollten Sie sich, falls Sie dies noch nicht 
getan haben, zuerst mit Haupt- und Nebenpfaden 
sowie dem I/O Setup-Dialogfeld vertraut machen. 

Einführung in das Surround-
Pannen in Pro Tools
(Nur Pro Tools HD)

Es stehen vier verschiedene Möglichkeiten zum 
Pannen von Spuren zur Verfügung: 

• das verkleinerte Panner-Raster im I/O-
Bedienfeld des Edit-Fensters

• das verkleinerte Panner-Raster im Mix-Fenster

• das Panner-Raster in Normalgröße im Output-
Fenster

• durch Bearbeiten der Panorama-Automation

Einige Pro Tools Bedienoberflächen stellen 
weitere Panning-Optionen zur Verfügung. Weitere 
Hinweise finden Sie in der Dokumentation zu Ihrer 
Bedienoberfläche. 

Unter Kapitel 47: „Surround-Setup“ finden 
Sie weitere Informationen über 
Mehrkanalkonfigurationen und I/O Setup-
Optionen. Hinweise zum Signal-Routing 
finden Sie unter Kapitel 48: 
„Mehrkanalspuren und Signal-Routing“.

Mehrkanal-Surround-Mischungen sind nur 
in Pro Tools HD möglich.
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Mix- und Edit-FensterPanner-
Raster
Im Mix- und im Edit-Fenster werden Mehrkanal-
Panner-Raster auf Spuren angezeigt, denen 
Mehrkanalspuren oder Send-Ausgänge 
zugewiesen wurden. 

So pannen Sie vom Mix- oder Edit-Fenster aus:

1 Vergewissern Sie sich im Edit-Fenster, dass das 
I/O-Bedienfeld angezeigt wird (View > Edit 

Window > I/O). Panner-Raster werden in Mix-
Fenster-Spuren, die Panoramaregelung 
unterstützen, immer angezeigt.

2 Starten Sie die Wiedergabe. 

3 Ziehen Sie im Mix- bzw. Edit-Fenster im Panner-
Raster der entsprechenden Mehrkanalspur.

Der Pan Location-Cursor folgt Ihren Bewegungen, 
solange Sie die Maustaste gedrückt halten. Die 
Bewegungen werden skaliert, d. h. sobald Sie 
klicken, um den Pan Location-Cursor „zu fassen“, 
sind Ihre Bewegungen nicht mehr auf den kleinen 
Bereich des Spurenrasters beschränkt. 

Farbe des Pan Location-Cursors bei der 
Automation

Der Pan Location-Cursor erscheint im Automation 
Read-Modus grün, im Automation Touch-, Latch-, 
Touch/Latch- oder Write-Modus rot und im 
Automation Off-Modus (oder im Automation 
Suspend-Modus) gelb.

Im Trim-Modus ist der Lautstärke- und LFE-
Fader gelb.

Output-Fenster enthalten zusätzliche Funktionen 
und Steuerelemente (und ein wesentlich größeres 
Raster). Weitere Hinweise finden Sie unter 
„Output-Fenster“ auf Seite 1186. 

Output-Fenster
Output-Fenster enthalten Steuerelemente zum 
Pannen von Spuren („Panner“) sowie 
standardmäßige Pro Tools-Steuerelemente für 
Spuren aller Mischformate (von 3-kanaligem LCR 
bis 8-kanaligem 7.1). 

Informationen über Standardsteuerelemente im 
Output-Fenster finden Sie unter 
„Standardsteuerelemente“ auf Seite 1187. 
Informationen über Panning-Steuerelemente im 
Output-Fenster finden Sie unter „Steuerelemente 
für Surround-Panner“ auf Seite 1188.

Ziehen, um im Spur-Raster zu pannen
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Output-Fenster bieten unter anderem folgende 
Funktionen:

• X/Y-Pannen (Joystick)

• 3-Knopf-Pannen

• Volle Divergenz und prozentuale Center-
Steuerung

• AutoGlide

• LFE-Signalbestimmung

• Mehrkanal-Pegelanzeigen

• Unterstützung des Zielfensters von Pro Tools

Sie können gleichzeitig mehrere Panner öffnen 
oder den aktuellen Panner in einem einzigen 
Fenster anzeigen.

So rufen Sie ein Output-Fenster auf:

 Klicken Sie auf die Output Window-
Schaltfläche (den kleinen Fader an der rechten 
Seite des Output-Selektors bei einer Spur im 
Mix- oder Edit-Fenster (I/O-Bedienfeld).

Standardsteuerelemente
Alle Output-Fenster enthalten Standard-
Pro Tools-Steuerelemente für das Routen, das 
Zuweisen von Pfaden und andere Spurfunktionen. 
Diese Steuerelemente befinden sich im Output-, 
Send-, Insert- und Plug-In-Fenster jeweils ganz 
oben (siehe „Standard-Selektoren in Output-
Fenstern“ auf Seite 1012).

Spurfader, Solo, Mute und Auto
Alle Output-Fenster bieten Steuerelemente zur 
Regelung der Spurlautstärke und 
Stummschaltung. Mithilfe dieser Elemente 
können Sie die Lautstärke der Spuren direkt 
anpassen und automatisieren oder Spuren 
stummschalten. Der größere Fader und die Mute-
Schaltfläche entsprechen den Steuerelementen im 
Mix-Fenster von Pro Tools. 

Öffnen eines Mehrkanal-Output-Fensters

Hinweise zum Verwalten mehrerer Output-
Fenster finden Sie unter „Output-Fenster für 
Spuren und Sends“ auf Seite 1009.

Panner-Steuerelemente

Track-Selektor

Output-Selektor

Path-Selektor Zielsymbol
Pegelanzeigen einblenden

Automation Safe



Pro Tools-Referenzhandbuch1188

Steuerelemente für Surround-Panner
Wenn der Output Spuren oder Pfaden mit mindestens vier Kanälen zugewiesen wurde, wird im Output-
Fenster ein X/Y-Raster für das Surround-Panning angezeigt. Die Lautsprecher für das jeweilige 
Mehrkanalformat des Panners werden außerhalb des Panner-Rasters an ihren relativen Positionen 
angezeigt. Diese Lautsprecher werden auch als Snap Pan to Speaker-Steuerelemente verwendet.

In diesem Abschnitt werden die Steuerelemente und Funktionen eines Mehrkanal-Panners von Pro Tools 
beschrieben. 

Output-Fenster mit Mehrkanal-Panner im 7.1-Format

X/Y-Raster

LFE-Fader

Spurfader und -Pegelanzeige

Position 
(Panner-Regler)

Divergenz

Pan Location-Cursor

Panning Mode-

Schaltfläche

Spurautomation, 

Solo und Mute

Center %

Snap Pan to Speaker-Symbole

Zur Anzeige der 

Pegelanzeigen 

hier klicken
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X/Y-Raster und Pan Location-
Cursor
Im X/Y-Raster werden Informationen zum 
Mehrkanal-Pannen angezeigt und eingegeben. 
Außerdem können Sie Pan-Daten entweder über 
den X/Y-Modus, 3-Knopf-Modus oder die 
Eingabe numerischer Werte in die 
Positionsdatenfelder eingeben. Sie können die 
Panorama-Automation im Edit-Fenster auch 
grafisch bearbeiten.

Die Standardeinstellung für Mehrkanal-Panner ist 
der X/Y-Modus. Im X/Y-Modus ist die aktuelle 
Pan-Position der Spur durch einen grünen Punkt 
gekennzeichnet. Dieser Punkt ist der Pan 
Location-Cursor. Seine Farbe zeigt den Status der 
Spurautomation an (Pro Tools-Standardfarben). 

Grün – die Spur befindet sich im Automation 
Read-Modus.

Rot – die Spur befindet sich im Automation Write-, 
Touch-, Latch- oder Touch/Latch-Modus.

Gelb – die Spur befindet sich im Automation Off- 
bzw. Automation Suspend-Modus.

Panning Mode-Schaltfläche
Diese Schaltfläche, die sich unter dem X/Y-Raster 
befindet, bietet den Zugriff auf die Surround-
Panning-Modi (siehe „Panning-Modi“ auf 
Seite 1190). 

Positionssteuerelemente
Mithilfe der Positionssteuerelemente können Sie 
die Position des Panners bestimmen.

Front – regelt die aktuelle Panner-Position für die 
X-Achse vorn (links/rechts). 

Rear – regelt die aktuelle Panner-Position für die 
X-Achse hinten (links/rechts). Im X/Y-Standard-
Pan-Modus sind die hintere und vordere Position 
gekoppelt und können nicht unabhängig 
voneinander eingestellt werden. 

F/R (Front/Rear) – dieses Steuerelement regelt die 
aktuelle Panner-Position für die Y-Achse. 

Center %-Steuerelement
Der Center-Prozentsatz regelt, wie viel vom Signal 
auf den Center-Lautsprecher geroutet wird. 
Mithilfe dieses Reglers können Sie eine Spur zu 
den vorderen Lautsprechern mischen, indem Sie 
im vorderen Bereich entweder eine Phantom-
Schallquelle (Center: 0 %) oder drei Schallquellen 
(LCR) verwenden. 

Steuerelemente für Divergenz
Die Divergenz steuert die Breite der gepannten 
Signalausgabe in Bezug auf die benachbarten 
Lautsprecher. Weitere Informationen finden Sie 
im Pro Tools-Handbuch zu Synchronisations- und 
Surround-Konzepten. Es stehen drei 
Divergenzsteuerelemente zur Verfügung:

Front-, Rear- und F/R-Divergenz: Diese 
Drehregler bieten eine automatisierbare 
Divergenzkontrolle über die Frontlautsprecher, 
die hinteren Lautsprecher bzw. zwischen vorderen 
und hinteren Lautsprechern.

Beispiele über die Auswirkungen von 
Divergenzeinstellungen auf das Panning 
finden Sie unter „Divergenz und Center-
Prozentsatz“ auf Seite 1194.
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Snap Pan to Speaker-Symbole
Mit den Snap Pan to Speaker-Symbolen können 
Sie den Panner auf die Position des Lautsprechers 
festlegen. Beispiel: Wenn Sie auf den linken 
oberen Lautsprecher klicken, wird der Pan 
Location-Cursor in die obere linke Ecke des X/Y-
Rasters verschoben.

LFE-Fader
Der LFE-Fader steht nur in Surround-Formaten 
des Typs x.1 (5.1, 6.1 und 7.1) zur Verfügung. 

Der LFE-Fader steuert, wie viel vom Signal der 
aktuellen Spur auf den LFE-Kanal geroutet wird. 
LFE-Fader in Spur- und Send-Fenstern können 
sich nach Gruppen richten. Der LFE-Kanal von 
Pro Tools deckt immer die volle Bandbreite ab. 
Weitere Hinweise zur Verwendung des LFE-
Faders finden Sie unter „LFE-Fader für 
Mehrkanal-Panner“ auf Seite 1196.

Mehrkanal-Panner-Kopplung
Stereospuren mit Mehrkanalausgängen verfügen 
über Mehrkanal-Panner für links und rechts. Das 
Output-Fenster enthält Steuerelemente, mit denen 
der linke und rechte Kanal für ein präzises Panning 
gekoppelt werden können.

Wenn Sie eine Stereospur erstellen, die auf einen 
Mehrkanalausgang geroutet ist, sind 
standardmäßig die folgenden Steuerelemente zur 
Panner-Koppelung aktiv:

• Link (koppelt linkes und rechtes Panner-
Steuerelement)

• Front Inverse (kehrt vordere gekoppelte 
Steuerelemente links und rechts um)

• Rear Inverse (kehrt hintere gekoppelte 
Steuerelemente links und rechts um)

Das Panner-Steuerelement zur Umkehrung an der 
Vorder-/Rückseite ist standardmäßig nicht 
gekoppelt. 

Panning-Modi
Die Panning Mode-Schaltfläche bietet Zugriff auf 
vier Panning-Modi: X/Y, Divergence Editing, 
3-Knob und AutoGlide. Panner-Steuerelemente 
können in allen vier Modi automatisiert werden.

Pro Tools bietet folgende Panning-Modi:

X/Y-Modus – Pannen im Joystick-Modus durch 
Ziehen des Pan Location-Cursors im X/Y-
Lautsprecherraster. Weitere Hinweise finden Sie 
unter „X/Y-Panning“ auf Seite 1191.

3-Knopf-Modus – Pannen von Punkt zu Punkt 
zwischen Lautsprecherpaaren. Weitere Hinweise 
finden Sie unter „3-Knopf-Pannen“ auf Seite 1192. 

Divergenzbearbeitung – Sie können das 
Divergenz-X/Y-Raster mit der Maus ziehen, um 
die Grenzen der Divergenz zu ändern. Siehe 
„Divergenzbearbeitungsmodus“ auf Seite 1195. 

AutoGlide-Modus – Pannen von Punkt zu Punkt 
vom Pan Location-Cursor zu einem neuen Ziel 
über eine angegebene „AutoGlide Time“ hinweg. 
Weitere Hinweise finden Sie unter „AutoGlide-
Modus“ auf Seite 1193.

Stereo-Mehrkanal-Panner-Steuerelemente mit 
Standardkoppelung

Link 

Umkehrung
vorn/hinten

Umkehrung vorn

Umkehrung hinten
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So aktivieren Sie einen Panning-Modus:

 Klicken Sie im Surround Panner auf die 
Panning Mode-Schaltfläche, bis das 
Modussymbol angezeigt wird.

X/Y-Panning

So pannen Sie im X/Y-Modus:

1 Klicken Sie auf die Panning Mode-
Schaltfläche, bis das X-Y-Modussymbol 
angezeigt wird.

2 Ziehen Sie den Pan Location-Cursor oder 
klicken Sie auf eine beliebige Stelle im Raster 
und ziehen Sie den Cursor, um die Spur zu 
pannen. Die Position des Pan Location-Cursors 
bestimmt die Pan-Position des Signals. Um etwa 
ein Signal auf den linken hinteren Lautsprecher 
zu pannen, ziehen Sie den Pan Location-Cursor 
zur linken unteren Ecke des Rasters. 

So springen Sie mit dem Pan Location-Cursor an 
eine bestimmte Stelle im Raster:

 Klicken Sie bei gedrückter Strg- und 
Umschalttaste (Windows) bzw. Befehls- und 
Umschalttaste (Mac) auf die Position im X/Y-
Raster.

Rasteroptionen und Verknüpfungen

Feinabstimmungsmodus – halten Sie die Strg-
Taste (Windows) bzw. die Befehlstaste (Mac) 
gedrückt, um eine Feinabstimmung der Panner-
Steuerelemente zu erreichen. 

Beschränken des Pannens auf Bewegungen 
entlang der X- bzw. Y-Achse – ziehen Sie den Pan 
Location-Cursor bei gedrückter Umschalttaste, 
um die Bewegungen des Cursors auf die X- oder 
Y-Achse zu beschränken.

Zurücksetzen auf die Standardeinstellung – 
klicken Sie bei gedrückter Alt-Taste (Windows) 
bzw. Wahltaste (Mac) in das Panner-Raster, um 
alle Steuerelemente auf die Standardeinstellungen 
zurückzusetzen. 

Panorama an Lautsprecher ausrichten – klicken 
Sie auf ein Snap Pan to Speaker-Symbol, um den 
Panner auf die entsprechende Position des 
Lautsprechers auszurichten. 

Anzeigen der Automation im Edit-Fenster – 
klicken Sie bei gedrückter Strg- und Windows-
Taste (Windows) bzw. Befehls- und Ctrl-Taste 
(Mac) auf ein Steuerelement, um die Playlist 
dieses Steuerelements im Edit-Fenster anzuzeigen.

Sie müssen nicht genau auf den Pan 
Location-Cursor klicken. Es genügt, auf eine 
beliebige Stelle im Raster zu klicken, um den 
Pan Location-Cursor relativ zu dieser 
Position zu verschieben bzw. die Steuerung 
an einen Hardware-Panner zu übergeben. 
Die Pan-Position springt dabei nicht an die 
Stelle, auf die Sie geklickt haben. 

Alle Pan-Parameter, auch Pan-Position und 
Divergenz, können automatisiert werden. 
Weitere Hinweise finden Sie unter 
Kapitel 45: „Automation“. 
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3-Knopf-Pannen
Eine weitere Möglichkeit, in Pro Tools Pan-
Bewegungen zu steuern, ist der 3-Knopf-Modus. 

Im 3-Knopf-Modus stehen Ihnen folgende 
Möglichkeiten zur Verfügung:

• Pannen in geraden Linien, indem Sie den Pan 
Location-Cursor mittels der 
Positionsdrehreglern vollbeweglich im vorderen 
und hinteren Bereich sowie zwischen vorn und 
hinten verschieben

• separates Pannen zwischen Lautsprecherpaaren

Wenn Sie etwa im 3-Knopf-Modus zwischen dem 
linken vorderen und dem rechten hinteren 
Lautsprecher pannen, ist das Audiosignal nur in 
diesen beiden Lautsprechern zu hören 
(vorausgesetzt, die volle Divergenz ist aktiviert). 

Im Vergleich dazu ist Audio bei einer diagonalen 
Pan-Richtung im X/Y-Modus in einigen oder allen 
Lautsprechern zu hören. 

Der Unterschied zwischen den beiden Modi 
besteht darin, dass das Signal im 3-Knopf-Modus 
separat zwischen der vorderen und hinteren 
Position des Pan-Verlaufs gepannt wird, während 
das Pannen im X/Y-Modus im gesamten 360°-
Pan-Raster erfolgt. Divergenz und Center-
Prozentsatz sind in beiden Pan-Modi variabel. 

So aktivieren Sie den 3-Knopf-Panning-Modus:

 Klicken Sie auf die Panning Mode-
Schaltfläche, bis das 3-Knopf-Modussymbol 
angezeigt wird.

Die Linie des Panner-Verlaufs erstreckt sich von 
vorn (X-Achse) nach hinten (Y-Achse) quer über 
das Raster.

So pannen Sie im 3-Knopf-Modus:

1 Stellen Sie die Verlaufslinie mithilfe der Front- 
und Rear-Drehregler ein. 

2 Drehen Sie den Front/Rear-Positionsregler, 
um das Signal entlang des Verlaufs zu pannen. 
Der Pan Location-Cursor kann nur entlang der 
weißen Verlaufslinie verschoben werden. 

Um die Winkel des 3-Knopf-Verlaufs zu ändern, 
haben Sie folgende Möglichkeiten:

 ziehen Sie einen der Endpunkte (vorne oder 
hinten) der Verlaufslinie mit der Maus

 passen Sie die Front- oder Rear-
Positionssteuerelemente an 

Pannen und Pegelanzeige im 3-Knopf-Modus

3-Knopf-Verlauf

3-Knopf-Modus

Panning-Modus 3-Knopf
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So verschieben Sie die aktuelle Verlaufslinie (von 
links nach rechts) unter Beibehaltung der Winkel:

 Ziehen Sie die Verlaufslinie (nicht die 
Endpunkte) an eine neue Position. 

AutoGlide-Modus
Im AutoGlide-Modus können Sie schnell den 
Surround Panner automatisieren, indem Sie auf die 
neuen Positionen im Surround Panner-Fenster 
klicken, anstatt die Surround Panner-
Steuerelemente manuell zu bewegen.

Die Zeit, die von einem Punkt zum nächsten 
(vom Pan Location-Cursor zum neuen Ziel) 
benötigt wird, wird „AutoGlide Time“ genannt. 
Diesen Zeitwert können Sie auf der Mixing 
Preferences-Registerkarte festlegen. Mögliche 
Werte reichen von 10 ms bis 10.000 ms 
(10 Sekunden).

So legen Sie die AutoGlide-Zeit fest:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Mixing. 

2 Legen Sie im Automation-Abschnitt die 
AutoGlide-Zeit fest.

So führen Sie einen AutoGlide-
Automationsdurchgang aus:

1 Klicken Sie auf die Panning Mode-
Schaltfläche, bis das AutoGlide-Modussymbol 
angezeigt wird.

Auf der Panning Mode-Schaltfläche wird eine 
schräge gepunktete Linie mit einem dicken Punkt 
am Ende (dem Cursor) in der rechten oberen Ecke 
angezeigt.

2 Klicken Sie im Mix- oder Edit-Fenster auf den 
Automation Mode-Selektor und wählen Sie 
einen Automatisierungsmodus für die zu 
automatisierenden Spuren.

3 Klicken Sie auf „Play“, um die Wiedergabe 
zu starten.

4 Legen Sie ein neues Ziel für den Cursor fest. 
Dazu haben Sie folgende Möglichkeiten:

• Klicken Sie auf ein Snap Pan to Speaker-
Symbol, um den Cursor auf die entsprechende 
Lautsprecherposition zu verschieben.

• Klicken Sie in das Pan-Fenster, um den Cursor 
auf einen bestimmten Punkt im X/Y-Raster zu 
verschieben.

Der Pan Location-Cursor wird auf das Ziel 
verschoben. Die Dauer dieses Vorgangs hängt von 
der AutoGlide-Zeit ab. Wenn der neue Zielpunkt 
erreicht ist, wird ein neuer Breakpoint an die neue 
Position geschrieben.

5 Wiederholen Sie den vorherigen Schritt, wenn 
Sie weitere Panning-Bewegungen erstellen 
möchten.

6 Halten Sie den Transport an, wenn Sie fertig sind.

Beim Automatisieren im AutoGlide-Modus 
kann der Pan Location-Cursor nicht von 
seiner Position entfernt werden.

Panning-Modus AutoGlide

Panning Mode-Schaltfläche (AutoGlide-Modus aktiv)

AutoGlide-Modus

Snap Pan to 
Speaker-
Symbole

Pan Location-
Cursor
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Divergenz und Center-
Prozentsatz
Mit den Steuerelementen für Divergenz und 
Center-Prozentsatz können Werte zwischen 0 und 
100 eingestellt und auch automatisiert werden. 
Diese Funktionen sind besonders in großen 
Räumen nützlich, da dadurch der Klang und die 
Klarheit von Stimmen verbessert wird. 

Front Divergence – steuert die Divergenz 
zwischen den Frontlautsprechern (nur X-Achse). 

Rear Divergence – steuert die Divergenz zwischen 
den hinteren Lautsprechern (nur X-Achse).

Front/Rear Divergence – steuert die Divergenz 
zwischen den vorderen und den hinteren 
Lautsprechern (Y-Achse).

Center % (Percentage) – bestimmt die Erstellung 
einer separaten Center-Schallquelle, einer 
kompletten Phantom-Center-Schallquelle oder 
einer variablen Zwischenstellung. 

Side % (Percentage) – bestimmt die Erstellung 
einer separaten seitlichen Schallquelle, einer 
kompletten seitlichen Phantom-Schallquelle oder 
einer variablen Zwischenstellung zwischen linken 
und rechten Kanälen bei den Formaten 7.1 und 7.0. 

Divergenz
Die aktuellen Divergenzwerte werden im Panner-
Raster durch eine violette Umrahmung dargestellt. 

Standardmäßig sind die Surround-Panner von 
Pro Tools zu 100 % (also vollständig) divergent, 
d. h. ein Signal, das vollständig auf einen 
Lautsprecher gepannt ist, ist nur auf diesem 
Lautsprecher zu hören. 

Divergenzanzeige und Steuerelemente

Divergenzanzeige

Steuerelemente für 
Divergenz
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Niedrigere Divergenzeinstellungen erzeugen ein 
zunehmend breiteres Ausgangssignal. Wenn die 
Divergenz weniger als 100 % beträgt, sind Spuren 
zu einem bestimmten Prozentsatz auch auf 
benachbarten Lautsprechern zu hören, selbst wenn 
der Pan Location-Cursor auf einen einzigen 
Lautsprecher eingestellt ist. 

So regeln Sie die Divergenz:

 Stellen Sie die Divergenzregler für Front, 
Rear und Front/Rear entsprechend ein. 

Divergenzbearbeitungsmodus
Im Divergenzbearbeitungsmodus können Sie die 
Grenzen der Divergenz anpassen, indem Sie direkt 
im Divergenzraster ziehen. 

So passen Sie die Divergenz grafisch an:

1 Klicken Sie auf die Panning Mode-
Schaltfläche, bis das Divergence Editing-
Symbol angezeigt wird.

2 Ziehen Sie die Divergenzgrenzen im Raster mit 
der Maus, um sie entsprechend anzupassen. 

Center % (Percentage)
Bei den Formaten LCR, LCRS, 5.0, 5.1, 6.0, 6.1 
7.0, 7.0 SDDS, 7.1 und 7.1 SDDS steuert 
Center %, ob ein getrennter Center-Kanal oder ein 
Phantom-Center-Kanal für die Spur vorliegt. 

Beispiel für den Center-Prozentsatz

Bei Film- und Videoproduktionen enthält der 
Center-Kanal oft den Dialog. Damit der Dialog 
besser hörbar ist, sollten Sie andere Elemente (etwa 
Musik) nicht auf den Center-Lautsprecher routen. 
So können Sie beispielsweise durch Verringern des 
Center-Prozentsatzes bei Musikspuren die Musik, 
die in den Frontlautsprechern zu hören sein soll, nur 
auf den linken und rechten Lautsprecher pannen und 
dadurch den Eindruck einer variablen Phantom-
Center-Schallquelle entstehen lassen.

Front-Divergenz unter 100 % bei breiterem Panning

Front
Divergenz

Pan Location- 
Cursor

Panning-Modus Divergenzbearbeitung
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So stellen Sie den Center-Prozentsatz ein:

 Stellen Sie den Drehregler für den Center-
Prozentsatz ein.

Je geringer der Center-Prozentwert ist, desto 
schwächer wird die Anzeige des Center-
Lautsprechers oben im Raster. Beim Wert 0 wird 
der Lautsprecher vollkommen unsichtbar, was 
bedeutet, dass es sich nun um eine reine Phantom-
Schallquelle handelt.

Side % (Percentage)
Bei den Surround-Formaten 7.1 und 7.0 steuert 
Side %, ob getrennte Seitenkanäle für die Spur 
oder ein Phantom-Seitenkanal vorliegt. 

So stellen Sie den Side-Prozentsatz ein:

 Stellen Sie den Drehregler für den Side-
Prozentsatz ein. 

Wenn Sie den Side-Prozentwert reduzieren, 
werden die Lautsprecher an den Seiten des Rasters 
leiser. Beim Wert 0 wird der Lautsprecher 
vollkommen stumm, was bedeutet, dass es sich 
nun um eine reine Phantom-Schallquelle handelt.

LFE-Fader für Mehrkanal-
Panner
Der LFE-Fader steuert die an den LFE-Kanal 
gesendete Stärke. LFE-Fader stehen nur dann zur 
Verfügung, wenn eine Spur einem Pfad 
zugewiesen wurde, dessen Format LFE unterstützt 
(5.1, 6.1 oder 7.1). 

So mischen Sie Signale zum LFE-Kanal dazu:

 Stellen Sie den LFE-Fader in einem Output-
Fenster eines beliebigen Surround-Formats des 
Typs x.1 ein. 

Center-Prozentwert auf 0 gesetzt (kein 
Frontlautsprecher dargestellt)

Side % auf 50 % (Seitenlautsprecher abgeblendet)

Allgemeine Informationen zu LFE, Sub-
Kanälen und verwandten Themen finden Sie 
im Pro Tools-Handbuch „Sync & Surround 
Concepts“.
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LFE-Fader und Gruppen
LFE-Fader für Spuren und Sends können sich 
sowohl an Mix- als auch nach Edit-Gruppen 
ausrichten. Aktivieren Sie dazu im Create Groups- 
oder im Modify Groups-Dialogfeld auf der Group 
Attributes-Registerkarte die entsprechende 
Funktion. Die Ausrichtung von LFE-Fadern an 
Gruppen kann als globales Attribut oder 
gruppenspezifisch zugewiesen werden. Siehe 
„Auswählen von Gruppenattributen“ auf 
Seite 265.

LFE-Aktivierung
Einige Mehrkanal-Plug-Ins, darunter der 
Dynamics III-Mehrkanalkompressor/-Limiter, 
enthalten die LFE Enable-Funktion. Dadurch kann 
die Bearbeitung eines gegebenenfalls vorhandenen 
LFE-Kanals aktiviert oder umgangen (auf Bypass 
geschaltet) werden. 

So verarbeiten Sie den LFE-Kanal in einem 
Mehrkanal-Plug-In:

 Klicken Sie auf die LFE Enable-Option, um die 
Unterstützung von Mehrkanal-Plug-Ins zu 
aktivieren. Wenn die LFE-Bearbeitung aktiviert 
ist, erscheint „LFE Enable“ markiert. Ist die 
LFE-Verarbeitung auf Bypass geschaltet, 
erscheint die Anzeige grau.

Pan-Playlists
Mehrkanal-Panner verfügen über je eine 
Automations-Playlist pro Steuerelement, das die 
Pan-Position und Divergenz regelt. 

„LFE Enable“ im Dynamics III-Mehrkanalkompressor/-
Limiter

Ist „LFE Enable“ nicht verfügbar, 
verwenden Sie die Multimono-Version des 
Plug-Ins.

Pan-Automation kann gezeichnet, editiert, 
ausgeschnitten, kopiert und aus dem Edit-
Fenster eingefügt werden. Weitere 
Informationen finden Sie unter Kapitel 45: 
„Automation“.
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Video
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Kapitel 50: Synchronisation in Pro Tools

Bei der Synchronisation gibt ein System den 
Timecode aus, während ein anderes Gerät diesem 
folgt (Verkopplung). Pro Tools nutzt für die 
Synchronisation mit anderen Geräten einen 
SMPTE/EBU- oder MIDI-Timecode.

Pro Tools-
Synchronisationsoptionen
Sie haben verschiedene Möglichkeiten bei der 
Synchronisation von Pro Tools mit einem externen 
Taktgeber sowie bei der Verwendung von 
Pro Tools als Master-Gerät.

Nur SMPTE-Trigger
Diese Lösung hilft bei kurzen Projekten, wenn die 
Geschwindigkeiten beider Systeme nahezu gleich 
sind. Aber auch die besten Systeme laufen selten 
länger als ein paar Minuten absolut synchron.

SMPTE-Trigger-Taktung mittels 
SYNC HD
(Nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme)

Sie können ein SYNC HD-Gerät verwenden, 
um die Aufnahme- und 
Wiedergabegeschwindigkeiten in Pro Tools mit 
einem der folgenden externen Taktgeber zu takten, 
während sich Pro Tools im Slave-Betrieb zum 
Timecode befindet:

• LTC 

• Videoquelle

• Studioweite Videoreferenz (SD oder HD)

• VITC

• 1x Wordclock

• AES/EBU-„Null“-Taktung

• Pilotton

• Bi-Phase

Damit kann eine sehr genaue Synchronisation über 
lange Zeiträume hinweg erzielt werden, da alle 
(Band-)Laufwerke des Systems über die gleiche 
Synchronisationsquelle getaktet sind bzw. sich im 
Slave-Betrieb zum Timecode auch eventuellen 
Unregelmäßigkeiten im eingehenden 
Timecode anpassen.
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SMPTE-Trigger beim Locken auf 
eine nicht getaktete Quelle
Der SMPTE-Trigger kann mit einem SYNC HD-
Gerät verwendet werden, um die Aufnahme- und 
Wiedergabegeschwindigkeit in Pro Tools beim 
Slave-Betrieb zum LTC zu steuern. Damit kann 
eine sehr genaue Synchronisation über lange 
Zeiträume hinweg erzielt werden, da alle (Band-
)Laufwerke des Systems sich auch eventuellen 
Unregelmäßigkeiten im eingehenden Timecode 
anpassen. SYNC HD unterstützt auch die 
Positionsreferenzen VITC und Bi-phase/Tach.

SYNC HD-
Synchronisationsoptionen
Wenn Sie Ihrem Pro Tools|HDX- oder 
Pro Tools|HD Native-System ein SYNC HD-
Gerät hinzufügen, können Sie Pro Tools als 
Master-Gerät für die Synchronisation einrichten. 
Alle weiteren Geräte werden dann von Pro Tools 
als Slave betrieben. 

Sie können Pro Tools in Verbindung mit einem 
SYNC HD zur Erzeugung von LTC, MIDI-
Timecode oder MMC-Befehlen verwenden. Wenn 
das SYNC HD eingehenden SMPTE-Timecode 
liest, generiert es den Timecode über den LTC- 
oder den MTC-Ausgangsanschluss neu. 
Das Signal kann so an andere Slave-Geräte 
weitergegeben werden.

MachineControl
SYNC HD unterstützt auch MachineControl-
Software, die viele spezielle Funktionen für 
Synchronisationsaufgaben bei der Postproduktion 
bietet, etwa ferngesteuerte Scharfschaltung von 
Spuren (Remote Track Arming), Videorekorder-
Emulation, seriellen Timecode und andere 
Funktionen. (Weitere Informationen erhalten Sie im 
MachineControl-Handbuch oder bei Ihrem Händler.)

Ext. Clock-Ausgang
Sie können Pro Tools bei der 
Synchronisationskonfiguration als Master-Gerät 
festlegen und alle anderen Geräte über die 
Pro Tools-Wordclock-Ausgabe als Slave 
betreiben. 

Für die Einstellung Ext. Clock Output:

1 Wählen Sie in Pro Tools Setup > Hardware.

2 Klicken Sie auf das Ext. Clock Output-Popup-
Menü und wählen Sie ein verfügbares 
Signal aus. 

3 Klicken Sie auf OK, um das Hardware Setup-
Dialogfeld zu schließen, wenn Sie alle 
Einstellungen vorgenommen haben.

Anweisungen zum Verbinden von SYNC HD 
mit Ihrem Pro Tools-System können Sie dem 
SYNC HD-Handbuch entnehmen.
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Session Setup-Fenster
Im Session Setup-Fenster können Sie verschiedene Einstellungen für den Timecode auf Ihrem System 
sowie bestimmte Einstellungen zum Session-Format (wie beispielsweise Bitrate, Pan-Tiefe, Audioformat 
und Interleaved) festlegen. Dieses Fenster enthält auch eigens für die Anzeige bestimmte Bereiche für 
Samplerate, Systemverzögerung und Timecode-bezogene Daten (wie z. B. eingehender Timecode). 

Das Session Setup-Fenster ist in drei Bereiche unterteilt: Der Abschnitt „Format“ befindet sich am oberen 
Rand des Fensters. Der SYNC Setup & Timecode Offsets- und der Timecode Settings-Abschnitt können 
ein- bzw. ausgeblendet werden.

So zeigen Sie das Session Setup-Fenster an:

 Wählen Sie in einer Pro Tools-Session Setup > 

Session.

So erweitern Sie den SYNC Setup & Timecode 
Offsets-Abschnitt:

 Klicken Sie auf die Expand/Collapse-Schaltfläche 
neben „SYNC Setup & Timecode Offsets“.

Mit den Steuerelementen in diesem Bereich 
können Sie die Einstellungen für SYNC HD 
konfigurieren. Verfügbare Einstellungen sind 
„Clock Reference“, „Positional Reference“, 
„Video Ref Format“, „Video In Format“ und 
„Variable Speed Override“ (VSO). 

Zur Anzeige des Timecode Settings-Abschnitts:

 Klicken Sie auf die Expand/Collapse-
Schaltfläche neben „Timecode Settings“.

Die Steuerelemente in diesem Bereich bieten 
Optionen zur Timecode-Erzeugung und zur 
Überbrückung („Freewheel“) sowie separate Pull-
Up- und Pull-Down-Selektoren für Audio- und 
Videoraten.

Session Setup-Fenster bei angeschlossenem SYNC HD

 

 

Format-Abschnitt

Taktquelle

Abschnitt „SYNC 
Setup & Timecode 
Offsets“

SYNC Setup-
Einstellungen

Abschnitt „Timecode 
Settings“

Generator-
Einstellungen

Session-Anzeigen 
und -Einstellungen

Einstellungen für die 
Neufestlegung des 
externen Timecodes

Timecode 
Reader-Offset

Pull-Up/Pull-Down-
Einstellungen

Freewheel-Einstellungen

Drücken Sie Strg + 2 (Windows) oder 
Befehl + 2 (Mac), um das Session Setup-
Fenster zu öffnen.
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Formatanzeigen und -
steuerungen im Session 
Setup-Fenster
Der Formatabschnitt des Session Setup-Fensters 
verfügt über Anzeigen und Steuerungen für 
Timecode-bezogene Einstellungen auf Ihrem 
System sowie für bestimmte Einstellungen zum 
Session-Format (wie beispielsweise Bitrate, Pan-
Tiefe, Audioformat und Interleaved).

Sample Rate
Diese Anzeige gibt die Samplerate der aktuellen 
Session an. 

Bit Depth
Diese Anzeige gibt die Bitrate der aktuellen 
Session an. Sie können die Bitrate für alle neu 
aufgenommenen oder importierten (und 
konvertierten) Dateien in der Session ändern, 
indem Sie eine andere Bit Depth-Option wählen. 
Informationen zu jeder Option finden Sie unter 
„Bitraten“ auf Seite 157.

Taktquelle
In diesem Menü können Sie den Taktgeber des 
Systems konfigurieren. Sie können zwischen 
SYNC HD, einem internen Taktgeber von einem 
Peripheriegerät oder einem an ein Avid HD-
Audio-Interface angeschlossenen externen 
Taktgeber wählen.

Clock Source-Optionen

SYNC – bei Verwendung von SYNC HD empfängt 
Pro Tools den Takt von diesem Gerät. SYNC HD 
kann den Takt wiederum von einem Taktgeber 
beziehen, der im SYNC Setup-Abschnitt des 
Session Setup-Fensters ausgewählt wurde. 

Internal – im Internal-Modus dient Ihr System als 
Referenz für den internen Taktgeber des 
Peripheriegeräts. Die Wiedergabe erfolgt mit der 
Samplerate der Session.

External Clock Sources – je nachdem, mit 
welchem Audio-Interface Sie arbeiten, können 
folgende Optionen für den externen Taktgeber 
verfügbar sein: AES/EBU, S/PDIF, S/PDIF Optical, 
ADAT Optical, TDIF und Word Clock (optionale 
Wordclock-Raten stehen bei höheren Frequenzen 
zur Verfügung). Externe Quellen können ein 
beliebiges Vielfaches der „Basisrate“ betragen. 
Die Basisrate liegt bei Quellen mit 88,2 und 
176,4 kHz bei 44,1 kHz. Die Basisrate liegt bei 
Quellen mit 96 und 192 kHz bei 48 kHz. Wenn 
eine externe Quelle ausgewählt ist und kein 
zulässiges Clock-Signal am External Clock-
Eingang gefunden werden kann, kehrt das I/O 
wieder in den Internal-Modus zurück.

Alle Änderungen, die am Taktgeber im 
Hardware Setup-Dialogfeld vorgenommen 
werden, erscheinen im Session Setup-Fenster.

Wenn im Peripherals-Dialogfeld ein 
SYNC HD aktiviert und korrekt an die Loop 
Sync-Kette angeschlossen ist, kann 
SYNC HD als Loop Master fungieren 
und die Audio-Interfaces folgen als Loop 
Sync-Slaves.

Weitere Informationen zu externen 
Taktgebern finden Sie im Handbuch zu 
Ihrem SYNC HD.
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System Delay
Wenn der Verzögerungsausgleich aktiviert ist 
(Options > Delay Compensation), zeigt diese 
Anzeige die Gesamtverzögerung (in Samples) an, 
die vom System zum Ausgleich der Plug-In- und 
Mixer-Routing-Verzögerungen angewendet wird. 

Pan Depth
In diesem Menü können Sie die Pan-Tiefe für 
Stereoausgangspfade in einer Pro Tools-Session 
wählen. Die Pan-Tiefe ist die Signaldämpfung, 
wenn eine Spur auf einen Stereoausgang geleitet 
und zentral gepannt wird. Informationen zu jeder 
Option finden Sie unter „Stereo Pan Depth“ auf 
Seite 990.

Audio Format
Diese Anzeige gibt das aktuelle Dateiformat der 
in der Session aufgenommenen Dateien an. 
Sie können das Audiodateiformat für alle 
neu aufgenommenen oder importierten (und 
konvertierten) Dateien in der Session ändern, indem 
Sie eine andere Audio Format-Option auswählen. 
Weitere Informationen dazu finden Sie unter 
„Gemischte Audiodateiformate“ auf Seite 158.

Interleaved
Aktivieren Sie die Interleaved-Option, um 
sicherzustellen, dass alle neu aufgezeichneten oder 
importierten (und konvertierten) Stereo- oder 
Mehrkanaldateien in der Session Interleaved-
Audiodateien sind. Weitere Informationen dazu 
finden Sie unter „Mehrkanal-Interleaved und 
Multimono-Audiodateien“ auf Seite 158.

Session Start
In diesem Feld können Sie für Ihre Session einen 
Frame-Rand für den SMPTE-Start angeben. 
Weitere Informationen finden Sie unter 
„Einstellen einer SMPTE-Startzeit für eine 
Session (Start-Frame)“ auf Seite 1210.

Incoming Time (Current Time)
Diese Anzeige weist auf eingehenden Timecode 
von einer externen Quelle hin. 

Timecode Rate
Mit der Timecode Rate-Einstellung können Sie die 
SMPTE-Timecode-Rate für die aktuelle Session 
wählen. 

Feet+Frame Rate 
Mit der Feet+Frame Rate-Einstellung können 
Sie die Feet+Frame-Raten für Sessions wählen. 
Es werden Raten von 23,976, 24 und 25 fps 
unterstützt.

Setzen Sie diese Rate auf die Rate des Filmprojektors 
bzw. des Videos, wenn die Geschwindigkeit 
des Filmprojektors berücksichtigt wird. Bei einer 
Filmabtaster-Übertragung (Telecine) von einem 
Filmprojektor mit 24 fps auf NTSC-Video müsste 
der Projektor beispielsweise mit 23,976 fps betrieben 
werden. Dies gilt unabhängig davon, ob die Session 
Audio-Pull-Down verwendet oder nicht.

Timecode 2-Rate 
Mit der Timecode 2 Rate-Einstellung können Sie 
eine zweite Framerate festlegen, die in der Leiste 
neben der Haupt-Timecode-Leiste angezeigt 
werden kann. Damit können Sie Framerates in der 
Timeline als Bezugsgröße angeben, die sich von der 
Timecode-Rate der Session unterscheiden (siehe 
dazu auch „Zeitbasis-Leisten“ auf Seite 791).
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Abschnitt „SYNC Setup and 
Timecode Offsets“ im 
Session Setup-Fenster
Der Abschnitt „SYNC Setup and Timecode 
Offsets“ im Session Setup-Fenster enthält 
Anzeigen und Menüs für Timecode-bezogene 
Einstellungen auf Ihrem System. 

SYNC-Setup
(Nur Pro Tools|HDX- und Pro Tools|HD Native-
Systeme mit SYNC HD)

Mit den Steuerelementen im SYNC Setup-
Abschnitt des Session Setup-Fensters können 
Sie die Einstellungen für SYNC HD festlegen, 
einschließlich Taktgeber, Positionsreferenz, 
Video-Eingangsformat und VSO (Variable 
Speed Override).

Clock Reference

– in diesem Menü können Sie die Clock-Referenz 
für Pro Tools einstellen.

 Für die Verwendung von SYNC HD sind im 
Clock Reference-Selektor alle unterstützten 
Clock-Typen aufgeführt.

 Bei Verwendung von Pro Tools|HDX- oder 
Pro Tools|HD Native-Systemen ohne SYNC HD 
können Sie unter allen momentan aktivierten 
digitalen Formaten oder Quellen wählen, die über 

das Avid HD-Audio-Interface verfügbar sind 
(etwa AES, S/PDIF oder 1x Word, die über den 
Word Clock-Eingang des Avid HD-Audio-
Interface eingehen).

Positional Reference

– bestimmt die Timecode-Quelle für die von 
Pro Tools verwendete Positionsreferenz. 

Video Ref Format

– legt das Video-Referenzformat für SYNC HD 
fest.

Video In Format

– gibt das erwartete Format bei einem Video In-
Anschluss eines SYNC HD an. Bei einigen HD-
Raten wird ein Popup-Menü geöffnet, in dem ein 
Format ausgewählt werden kann.

Variable Speed Override (VSO)

Erfordert ein SYNC HD. Wenn ein SYNC HD an 
ein Pro Tools|HDX- oder Pro Tools|HD Native-
System angeschlossen ist, befinden sich die VSO-
Steuerelemente im SYNC Setup-Abschnitt des 
Session Setup-Fensters. 

Wenn Sie Varispeed mit HD MADI verwenden, 
ist es möglich, dass die verfügbare Bandbreite 
überschritten wird. Wenn Varispeed die maximal 
mögliche Frequenz für die aktuelle nominale 
Samplerate überschreitet, kommt es zu Audio-
Ausfällen. In der folgenden Tabelle ist die 
maximale Frequenz für Varispeed zu jeder 
nominalen Samplerate aufgelistet.

SYNC-Setup
Im Handbuch zu Ihrem SYNC HD erhalten 
Sie Anweisungen dazu, wie mit VSO die 
Wiedergabegeschwindigkeit in Pro Tools 
variiert werden kann.



Kapitel 50: Synchronisation in Pro Tools 1207

Ref Present-, Locked- und Speed Cal-
Anzeigen

Die Ref Present-, Locked- und Speed Cal-
Anzeigen im SYNC Setup-Abschnitt des 
Session Setup-Fensters zeigen den 
Synchronisationszustand des SYNC HD an. 
Die Locked- und Speed Cal-Anzeigen geben 
den Status der gleichnamigen Leuchtdioden auf 
der Gerätevorderseite wieder.

Ref Present-Anzeige – die Anzeige für Ref 

Present leuchtet, wenn der Video Ref In-
Anschluss ein gültiges Videosignal empfängt. 

Locked-Anzeige – die Locked-Anzeige leuchtet 
grün, wenn SYNC HD stabil synchron mit der 
ausgewählte Clock-Referenz läuft. Die Locked-
Anzeige blinkt gelb, wenn die ausgewählte Clock-
Referenz-Quelle nicht vorhanden ist oder eine 
Frequenz aufweist, mit der nicht synchronisiert 
werden kann.

Speed Cal-Anzeige – diese Anzeige zeigt den 
Status des eingehenden Taktgebers an:

• Konstant gelb: SYNC HD läuft stabil synchron 
und der Taktgeber weicht nicht mehr als 
0,025 % von der erwarteten Rate ab.

• Blinkt gelb in kurzen Abständen: SYNC HD 
läuft stabil synchron, aber die Taktgeberrate ist 
zwischen 0,025 und 4 % schneller als erwartet.

• Blinkt gelb in langen Abständen: SYNC HD 
läuft stabil synchron, aber die Taktgeberrate ist 
zwischen 0,025 und 4 % langsamer als erwartet.

• Blinkt rot in kurzen Abständen: SYNC HD läuft 
stabil synchron, aber die Taktgeberrate ist über 
4 % schneller als erwartet.

• Blinkt rot in langen Abständen: SYNC HD läuft 
stabil synchron, aber die Taktgeberrate ist über 
4 % langsamer als erwartet.

• Leuchtet nicht: SYNC HD läuft nicht stabil 
synchron zum ausgewählten Taktgeber.

External Timecode Offsets
In Pro Tools können Sie im External Timecode 
Offsets-Abschnitt die konstante Verzögerung um 
eine feste Frame-Anzahl ausgleichen, die von 
bestimmten Geräten (etwa manche Video-Master 
mit Farbkorrektur) erzeugt wird. Außerdem ist es 
möglich, die Verzögerung bei Material mit einer 
anderen Startzeit als in der Session auszugleichen. 

Pro Tools bietet vier verschiedene Einstellungstypen 
für External Timecode Offsets. Diese sind:

• MMC (MIDI-Maschinensteuerung)

• 9-Pin (Deck-Steuerung)

• Synchronisations-Peripheriegeräte, 
einschließlich SYNC HD (nur Pro Tools|HDX- 
und Pro Tools|HD Native-Systeme) oder andere 
Peripheriegeräte (wie z. B. MIDI-Interfaces mit 
MIDI-Timecode). 

• Satellite

Maximale Samplerate-Begrenzung für Varispeed

Nominale 
Samplerate

Anzahl 
Kanäle

Maximale 
Frequenz

44,1/48 kHz 64 48,8 kHz

44,1/48 kHz 56 55,6 kHz

88,2/96 kHz 32 97,5 kHz

88,2/96 kHz 28 111,5 kHz

176,4/192 kHz 16 194,9 kHz

176,4/192 kHz 14 223,0 kHz

Ref Present-, Locked- und Speed Cal-Anzeigen
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Für jeden dieser Offset-Typen können eindeutige 
Werte festgelegt werden; alternativ dazu können 
sie auch verbunden werden, um eine gleichzeitige 
Anpassung aller Faktoren zu gewährleisten. 

Mithilfe der Eingabe von positiven bzw. negativen 
Werten können Sie die Timecode-Anzeige in 
Pro Tools nach vorn bzw. hinten verschieben. 

Bei Verwendung der MachineControl-Option 
stehen zusätzliche Optionen für External 
Timecode Offsets zur Verfügung. Weitere 
Informationen hierzu finden Sie im 
MachineControl-Handbuch.

Versatz für externen Timecode neu definieren

1 Wählen Sie Setup > External Timecode Offset.

2 Geben Sie im Dialogfeld „Redefine External 
Timecode Offset“ den gewünschten Versatz im 
Feld „Desired Timecode Position“ ein.

3 Klicken Sie auf OK.

Sample-Offset (Sync-Offset)

In diesem Feld können Sie einen Trigger Offset für 
den eingehenden MIDI-Timecode festlegen 
(zwischen –100.000 und +100.000 Samples). 
Mithilfe dieser Option können Sie einen 
permanenten Offset festlegen, mit dem Sie exakt 
die Position einstellen können, an der sich 
Pro Tools relativ zum eingehenden Timecode 
synchronisiert. Beispielsweise wird bei 
einem Wert von –50 ein Ereignis in Pro Tools 
50 Samples vor dem entsprechenden Ereignis im 
aktuellen MIDI-Timecode wiedergegeben. Nutzen 
Sie diese Funktion, um Unterschiede im Timing 
zwischen den verschiedenen SMPTE-/MIDI-
Timecode-Wandlern oder Digital/Analog- bzw. 
Analog/Digital-Wandlern auszugleichen. 

Dialogfeld zur Neufestlegung des externen 
Timecodes



Kapitel 50: Synchronisation in Pro Tools 1209

Timecode-Einstellungen im 
Session-Setup-Fenster

Freewheel
Mit den Auswahlmöglichkeiten im Freewheel-
Abschnitt können Sie festlegen, wie die 
Wiedergabe auch dann von Pro Tools fortgesetzt 
wird (Freewheel), wenn der Timecode 
unterbrochen oder beschädigt ist. Verwenden Sie 
diese Optionen zum Schutz gegen Fehler, die 
auftreten können, wenn Ihre SMPTE-Timecode-
Quelle „Drop-outs“ oder vorübergehende 
Signalausfälle hat.

None – keine Freewheel-Einstellung wird 
angewendet. 

Frames – legt eine Anzahl von Frames (1 bis 120) 
für Freewheel fest. Für die meisten Anwendungen 
empfiehlt sich die Standardeinstellung von 
8 Frames.

Jam Sync – ermöglicht es Pro Tools, die 
Synchronisation aus dem eingehenden Timecode 
herauszulesen und die Wiedergabe auch dann 
fortzusetzen, wenn der Timecode-Empfang 
vollständig unterbrochen wurde. Dies kann sich als 
nützlich erweisen, wenn Timecode beschädigt ist 
oder versehentlich vom Quellband gelöscht wurde.

Pull-Up/Pull-Down
Wenn Pro Tools in Verbindung mit einem 
SYNC HD-Gerät genutzt wird, können Sie die 
aktuelle Samplerate mittels Pull-Up oder Pull-
Down verändern.

Weitere Informationen zur Verwendung der Pull-
Funktionen in Pro Tools finden Sie unter „Pull-Up 
und Pull-Down“ auf Seite 1212. 

Vorbereitungen zum Betrieb 
mit SMPTE
Bevor Sie mit SMPTE arbeiten, müssen Sie 
zunächst eine geeignete SMPTE-Framerate 
bestimmen. Pro Tools unterstützt alle 
standardisierten SMPTE-Framerates. Wenn Sie 
mit einem SMPTE-formatierten Band arbeiten, 
ist es wichtig, die zugehörige Framerate zu 
kennen. In einigen Fällen kann hierzu das 
SYNC HD verwendet werden.

Konfigurieren von Pro Tools 
für SMPTE
Synchronisations- und MachineControl-
Systemeinstellungen werden im Pro Tools-
Peripherals-Dialogfeld (Setup > Peripherals) 
aktiviert. Bei diesen handelt es sich um 
Systemeinstellungen, die unabhängig von der 
aktuellen Session immer gleich sind. 
Konfigurieren Sie diese Einstellungen vor dem 
Öffnen einer neuen Session.

Andere Einstellungen (etwa Timecode Rate, 
Feet+Frames Rate, Start-Frame und 
Zeitanzeigeformat der Session) können im Session 
Setup-Fenster konfiguriert werden. Diese 
Einstellungen sind Session-spezifisch. Sie können 
nur festgelegt werden, wenn eine Session 
geöffnet ist.

Pull-Up und Pull-Down kann in 
verschiedenen Arbeitsabläufen 
unterschiedlich eingesetzt werden. 
Überprüfen Sie also den spezifischen 
Arbeitsablauf eines jeden Projekts, bevor Sie 
mit der Arbeit beginnen.

MachineControl wird nur bei 
Pro Tools|HDX- und Pro Tools|HD 
Native-Systemen unterstützt.
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Auswahl eines SMPTE-Formats

So wählen Sie ein SMPTE-Format:

1 Wählen Sie in Pro Tools Setup > Session.

2 Wählen Sie im Timecode Rate-Selektor eine 
Framerate (im SMPTE-Format) aus. 

3 Geben Sie (falls erforderlich) im Timecode 
Freewheel-Feld die gewünschte Anzahl von 
Frames ein (siehe „Freewheel“ auf Seite 1209).

Einstellen einer SMPTE-
Startzeit für eine Session 
(Start-Frame)
Mithilfe des Session Setup-Fensters können Sie 
außerdem ein SMPTE-Start-Frame für Ihre 
Session angeben. Drehkassetten starten nur selten 
bei einem SMPTE-Timecode von 00:00:00:00. Sie 
können eine Startzeit für Ihre Session auf 
Grundlage einer geeigneten Frame-Nummer aus 
Ihrer Drehkassette eingeben. Alle SMPTE-
Funktionen in Pro Tools (wie etwa der Spot-
Modus) verwenden nun diesen Wert als Referenz 
für den Startpunkt der Session.

Startzeit beim Striping eines Bandes

Bei der Erzeugung von Timecode empfiehlt es 
sich, das Striping bei einer Anfangszeit von 
01:00:00:00 zu beginnen. (Ziehen Sie dabei die 
Zeit für das Head-Format ab, wie Schwarzfilm, 
Balken und Klang, Logos.) Dadurch vermeiden 
Sie Probleme, die bei manchen Synchronizern 
auftreten können, wenn der Timecode von 
23:59:59:29 auf 00:00:00:00 umspringt 
(die sogenannte „Mitternachtsgrenze“).

So bestimmen Sie eine SMPTE-Startzeit für Ihre 
Session:

1 Wählen Sie Setup > Session. 

2 Geben Sie im Session Start-Feld eine SMPTE-
Frame-Adresse ein.

So erfassen Sie eine eingehende SMPTE-Adresse 
bei der Session-Startzeit:

1 Klicken Sie in das Session Start-Feld.

2 Starten Sie die Wiedergabe der Timecode-Quelle. 

3 Drücken Sie an der Stelle, an der der 
eingehende Wert erfasst werden soll, die Enter-
Taste des Ziffernblocks. 

4 Drücken Sie zum Übernehmen des Werts die 
Eingabetaste. Sie können die Adresse 
anschließend bearbeiten. Im Online-Betrieb 
verwendet die Session die von Ihnen eingegebene 
Frame-Adresse als SMPTE-Start-Frame.

• Wenn auf den Spuren bereits Clips bestehen und 
Sie das ursprüngliche SMPTE-Start-Frame 
zeitlich nach hinten versetzen (beispielsweise 
von 00:00:00:00 nach 01:00:00:00), bleiben alle 
Clips an ihrer relativen Position und werden um 
den Zeitwert später abgespielt, der zu dem Start-
Frame addiert wurde.

• Wenn Sie die Startzeit einer geöffneten Session 
ändern, in der bereits Spuren bestehen, wird 
nach dem Drücken der Enter-Taste eine 
Warnung angezeigt. Sie haben dann folgende 
Möglichkeiten:

Maintain Timecode – diese Option setzt die 
zusätzliche Session-Zeit an den Anfang der 
Session, dabei behalten bereits bestehende Clips 
ihre ursprünglichen Timecode-Positionen.

Maintain Relative Position – diese Option setzt die 
zusätzliche Session-Zeit an den Anfang der 
Session, dabei behalten bereits bestehende Clips 
ihre Positionen relativ zum neuen Start-Frame bei. 
Wenn Sie beispielsweise das Start-Frame der 
Session von 01:00:00:00 auf 00:59:00:00 
vorziehen, fügt Pro Tools eine Minute Session-
Zeit ein, um das neue Start-Frame anzupassen, und 
schiebt alle bestehenden Clips zeitlich nach vorn, 
um deren relative Position an dem Start-Frame 
auszurichten. 



Kapitel 50: Synchronisation in Pro Tools 1211

Neufestlegen einer 
Feet+Frames-Position
Verwenden Sie den Current Feet+Frames-Befehl, 
um die Feet+Frames-Position am aktuellen 
Einfügepunkt neu festzulegen. Die Startzeit der 
Session wird auf Grundlage der neuen, relativen 
Feet+Frames-Position neu berechnet. 

Dieser Befehl wird normalerweise zum Integrieren 
von Prüftönen, Pre-Roll, Academy Leader 
(Startband) und anderem vergleichbarem 
technischem Vorspann-Material in Pro Tools-
Sessions verwendet. Bei einer Neudefinition von 
Feet+Frames wird die Startzeit einer Session nicht 
neu definiert.

So legen Sie eine relative Frame-Position für eine 
Session fest (Feet+Frames):

1 Klicken Sie mit dem Selector-Tool in die Spur 
(oder nehmen Sie eine Selektion vor), in der die 
Position neu definiert werden soll.

2 Wählen Sie Setup > Redefine Current 

Feet+Frames Position.

3 Geben Sie eine Feet+Frames-Position an, die 
mit dem im Dialogfeld angezeigten Timecode 
übereinstimmt.

4 Klicken Sie auf OK.

Neudefinition einer Timecode-
Position
Mit dem Current Timecode Position-Befehl legen 
Sie die aktuelle Timecode-Position und die 
Startzeit der Session neu fest. Indem Sie einen 
Einfügepunkt (oder eine Selektion) erstellen und 
anschließend dafür eine neue Timecode-Position 
eingeben, weisen Sie Pro Tools an, die Startzeit 
der Session anhand der neuen relativen Timecode-
Position neu zu berechnen.

Neufestlegen einer Timecode-Position

1 Klicken Sie mit dem Selector-Tool in die Spur 
(oder nehmen Sie eine Selektion vor), in der die 
Position neu festgelegt werden soll.

2 Wählen Sie Setup > Current Timecode Position.

3 Geben Sie in das Dialogfeld eine neue SMPTE-
Frame-Adresse ein, die dem im Dialogfeld 
angezeigten Timecode entspricht.

4 Klicken Sie auf OK.

Befindet sich der Einfügepunkt bzw. die 
Selektion nicht auf einer Rastergrenze, 
so wird auf die nächstgelegene Grenze 
gerundet.

Befindet sich der Einfügepunkt bzw. die 
Selektion nicht auf einer Rastergrenze, 
so wird auf die nächstgelegene Grenze 
gerundet.
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Zeitanzeige in SMPTE-Frames
In Pro Tools können Sie die Anzeige der Haupt-
Zeitskala auf „Timecode (SMPTE)“ einstellen. 
Dies wird dann im Hauptzähler angezeigt. Obwohl 
Pro Tools weiterhin mit eingehendem SMPTE-
Timecode synchronisiert wird, auch wenn die 
Anzeige der Zeitskala in „Bars|Beats“, 
„Minutes:Seconds“ oder „Feet.Frames“ erfolgt, ist 
es in der Regel sinnvoll, den SMPTE-Timecode 
als Referenz zu verwenden.

Zum Einstellen der Haupt-Zeitskala auf SMPTE-
Timecode haben Sie folgende Möglichkeiten:

 Wählen Sie View > Rulers > Timecode.

 Klicken Sie im Edit-Fenster auf den Main 
Counter-Selektor und wählen Sie Timecode.

Pro Tools zeigt die Timecode-Werte mit der 
aktuell ausgewählten SMPTE-Framerate an.

Anzeigen von Nebenzähler und Sub-Zeitskala

Sie können eine Sub-Zeitskala im Nebenzähler 
anzeigen. Wenn Sie beispielsweise für die Haupt-
Zeitskala das Timecode-Format gewählt haben 
und die SMPTE-Zeit bei der Framerate 
„29,97 Non-Drop“ mit der „normalen“ Uhrzeit 
vergleichen möchten, klicken Sie auf den Sub 
Counter-Selektor und wählen Sie als Sub-
Zeitskala „Min:Secs“.

Pull-Up und Pull-Down
Pro Tools unterstützt Pull-Up/Pull-Down von bis 
zu 4 % und bietet sogar noch eine zusätzliche 
Erhöhung/Verringerung von 0,1 %. Die Frame-
Auflösung des Audio- und Videomaterials kann 
innerhalb einer Session separat eingestellt werden 
(sofern das Bildmaterial in die Session importiert 
oder erfasst wurde). 

Beachten Sie jedoch, dass der Pull-Up/Pull-Down-
Wert zwar als 4 % angegeben wird, aber dass es 
sich im Falle eines Pull-Ups eigentlich um 
4,167 % handelt.

Obwohl man SYNC HD für die Nutzung der 
erweiterten Pull-Up/Pull-Down-Optionen in 
Pro Tools nicht benötigt, ist es das einzige Gerät, 
das man von Pro Tools aus steuern kann und das 
beim Öffnen einer Session automatisch die 
richtigen Pull-Faktoren laden/wiederherstellen 
kann. Alle anderen Synchronisationsgeräte 
müssen manuell eingestellt werden. 

Die Pull-Up- und Pull-Down-Einstellungen 
haben keinen Einfluss auf den von SYNC HD 
erzeugten Timecode.
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Konfigurieren von Pull-Up und 
Pull-Down

So verwenden Sie Pull-Up oder Pull-Down mit 
Audio oder Video:

1 Wählen Sie Setup > Session.

2 Wählen Sie im Timecode Settings-Abschnitt 
des Session Setup-Fensters eine Pull-Up- bzw. 
Pull-Down-Rate.

Audio Rate Pull Up/Down – hiermit wird die 
Samplerate der Audiodaten gesteuert. Siehe 
„Audio-Samplerate-Pull-Up und -Pull-Down“ auf 
Seite 1214.

Video Rate Pull Up/Down – hiermit wird die 
Videorate gesteuert. Siehe „Video-Framerate-
Pull-Up und -Pull-Down“ auf Seite 1215. 

Die in diesen Menüs verfügbaren Optionen richten 
sich nach der Framerate der Session. Über die 
Simultanverwendung beider Menüs können auch 
kombinierte Werte eingestellt werden.

Die in diesen Menüs verfügbaren Optionen sind 
auch von den Einstellungen unter „Preferences“ 
und den Auto Match Pull Factors im Timecode 
Rate-Menü abhängig. Siehe „Erweiterte 
Einstellungen für Pull-Up, Pull-Down und Session 
Setup“ auf Seite 1213 und „Auto Match Pull 
Factors“ auf Seite 1213.

Erweiterte Einstellungen für 
Pull-Up, Pull-Down und Session 
Setup
Im Audio Rate Pull Up/Down-Menü stehen alle für 
die momentan verwendete Samplerate belegten 
Pull-Up/Pull-Down-Werte zur Verfügung. Die 
Framerate der Session ist dabei unerheblich. 

Wenn die Timeline außerdem ein QuickTime-
Movie enthält, kann die Videorate unabhängig von 
der Framerate nur um 0,1 % erhöht bzw. verringert 
werden. Obwohl immer davon abgeraten wurde, 
war bei früheren Pro Tools-Versionen ein Pull-
Down von QuickTime-Videoclips möglich, wenn 
für Audiomaterial ein Pull-Down aktiviert wurde. 
Pro Tools-Versionen ab 5.3.1 bieten diese 
Möglichkeit ebenfalls, um die Kompatibilität mit 
älteren Sessions zu wahren. 

Auto Match Pull Factors
Die Auto Match Pull Factors-Auswahl ist im 
Timecode Rate-Menü des Session Setup-Fensters 
verfügbar. Wenn Auto Match Pull Factors aktiviert 
ist, ändert Pro Tools die Rate der Audio- und 
Videowiedergabe automatisch, sobald eine andere 
Timecode-Rate für die aktuelle Session 
gewählt wird. 

Auto Match Pull wird immer im Verhältnis zur 
aktuellen Pull-Up-Einstellung berechnet. Bei 
Aktivierung ändert sich die Videoauflösung nur 
noch, wenn die Framerate innerhalb eines Bereichs 
geändert wird, in dem die Videodaten korrigiert 
werden können. 

Diese Einstellung bleibt erhalten; sie ist nicht 
standardmäßig aktiviert, aber ihr Status wird mit 
der Session gespeichert.

Drücken Sie Strg + 2 (Windows) oder 
Befehl + 2 (Mac), um das Session Setup-
Fenster zu öffnen.

Session-Setup-Fenster 

Der 4-%-Pull-Faktor ist für Sessions mit 
einer Samplerate von 176,4 oder 192 kHz 
nicht verfügbar.
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Beispiel für eine Auto Match Pull 
Factors-Einstellung
Die Auto Match Pull Factors-Einstellung sorgt für 
eine Koppelung der Pull-Faktoren bei Audio- und 
Videodaten, wenn die Framerate einer Session 
geändert wird. 

Nehmen wir an, die aktuelle Pro Tools-Session 
verwendet eine Auflösung von 25 fps, Audio und 
Video werden ohne Pull-Ups abgespielt und die 
Auto Match Pull Factors-Einstellung ist aktiviert. 

Wenn Sie die Framerate der Session nun zu 24 fps 
ändern, wird der Pull-Wert für die Audio- und 
Videodaten auf –4,0 % gestellt (die geeignete Pull-
Einstellung für diese Änderung). 

Die Auto Match Pull-Faktoren beziehen sich 
jeweils auf alle Audio Rate Pull Up/Down- und 
Video Rate Pull Up/Down-Einstellungen. 

Wenn die Audiodaten also bereits um –0,1 % 
versetzt werden (weil Sie die Framerate der 
Session von 29,97 zu 24 fps geändert haben), 
springt die Einstellung im Audio Rate Pull 
Up/Down-Menü auf None. 

Audio-Samplerate-Pull-Up und 
-Pull-Down
Im Audio Rate Pull Up/Down-Menü legen Sie die 
Pull-Up/Pull-Down-Faktoren für die 
Audioaufnahme und -wiedergabe in einer Session 
fest. Alle Pull-Raten sind unabhängig von der 
Framerate der Session verfügbar. 

Siehe auch „Auto Match Pull Factors“ auf 
Seite 1213.
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Audioraten und Pull-Up/Pull-Down-Optionen
In der nachstehenden Tabelle finden Sie eine Übersicht der tatsächlichen Samplerates der einzelnen Pull-
Up/Pull-Down-Optionen und die möglichen Kombinationen (Rundung auf das nächste ganze Hz):

Video-Framerate-Pull-Up und -
Pull-Down
Mit der Video Pull Up/Down-Einstellung kann die 
Framerate für die Video-Wiedergabe unabhängig 
von Audiokorrekturen (Pull-Up/Pull-Down) 
geändert werden.

Die möglichen Optionen für Video Rate Pull 

Up/Down sind abhängig vom Dateiformat und der 
Framerate des Videos. Die Video-Pull-Raten 
werden mit der Session abgespeichert. 

Samplerates der einzelnen Pull-Up/Pull-Down-Einstellungen

Pull-Up/ 
Pull-Down 

Samplerate

44100 48000 88200 96000 176400 192000

+4,1667 % 
und +0,1 %

45983 50050 91967 100100 – –

+4,1667 % 45938 50000 91875 100000 – –

+4,1667 % 
und –0,1 %

45892 49950 91783 99900 – –

+0,1 % 44144 48048 88288 96096 176576 192192

–0,1 % 44056 47952 88112 95904 176224 191808

–4,0 % und 
–0,1 %

42378 46126 84757 92252 – –

–4,0 % 42336 46080 84672 92160 – –

–4,0 % und 
–0,1 %

42294 46034 84587 92068 – –

Siehe auch „Auto Match Pull Factors“ auf 
Seite 1213.
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Auswirkung von Pull-Up- oder 
Pull-Down-Aktionen
In den folgenden Abschnitten erfahren Sie, wie 
sich Pull-Up/Pull-Down-Raten auf Pro Tools-
Funktionen auswirken. 

Video-Pull-Up und -Pull-Down 
und Timecode-Leiste
Die Pull-Up/Pull-Down-Einstellungen für 
Videomaterial haben keinen Einfluss auf die 
Timecode-Leiste. Vergessen Sie nicht, die 
Framerate der Session auf den im Projekt 
verwendeten Wert zu stellen. Beispiel: Wenn Sie 
mit 24-fps-Videomaterial arbeiten und dessen 
Auflösung um 4 % erhöhen, müssen Sie die 
Framerate der Session auf 25 fps stellen, damit 
die Angaben der Timecode-Leiste auch 
weiterhin stimmen. Das gilt auch umgekehrt: 
Wenn Sie 24-fps-Videomaterial um 0,1 % nach 
unten korrigieren, müssen Sie die Framerate der 
Session auf 23,976 stellen.

Wenn Sie mit 25-fps-Avid-Material arbeiten und 
die Bildauflösung um 4 % nach unten korrigieren, 
müssen Sie die Framerate der Session auf 24 fps 
stellen.

Plug-Ins und Pull-Up/Pull-Down
Bei hohen Pull-Werten (4 %) ist eine verlässliche 
Funktionsweise der Plug-Ins nur gewährleistet, 
wenn diese den Sample-Takt statt des absoluten 
Zeittakts verwenden. Alle Pro Tools-Audio-Plug-
Ins verwenden prinzipiell den Sample-Takt. 

Hohe Samplerates und Pull-
Faktoren
Der 4-%-Pull-Faktor ist für Sessions mit einer 
Samplerate von 176,4 oder 192 kHz nicht 
verfügbar.

Pro Tools im Online-Modus
Um die Wiedergabe oder Aufnahme in Pro Tools 
über ein externes Gerät auszulösen, muss 
Pro Tools-Transport online geschaltet sein. 
Pro Tools wartet dann auf den eingehenden 
Timecode. 

Um den Pro Tools-Transport online zu setzen, 
haben Sie die folgenden Möglichkeiten:

 Deaktivieren Sie Options > Transport Online. 

 Klicken Sie auf die Online-Schaltfläche im 
Transport-Fenster. 

Die Online-Schaltfläche blinkt und Pro Tools 
wartet auf ein SMPTE-Frame, das die Wiedergabe 
auslöst. Sobald der Timecode eingeht, startet die 
Wiedergabe, und die Online-Schaltfläche leuchtet 
auf. Die Edit Selection-Anzeigen im Edit-Fenster 
und das Incoming Time-Feld im Session Setup-
Fenster zeigen den eingehenden Timecode an. 

Wählen Sie eine der folgenden Methoden, um 
Pro Tools offline zu schalten:

 Deaktivieren Sie Options > Transport Online.

 Deaktivieren Sie die Online-Schaltfläche im 
Transport-Fenster.

Drücken Sie Strg + J (Windows) bzw. 
Befehl + J (Mac), um den Transport online 
zu setzen. 

Klicken Sie auf die Online-Schaltfläche im Transport-
Fenster. 
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Aufnahme im Online-Betrieb
Auf der Operation Preferences-Registerkarte 
stehen zwei Optionen zur Verfügung, mit denen 
Sie steuern können, wie die Aufnahme mit 
Pro Tools im Online-Betrieb erfolgt.

Record Online at Timecode (or ADAT) Lock – 
diese Option startet die Online-Aufnahme, 
sobald Pro Tools Timecode oder ADAT-
Synchronisationsdaten empfängt und stabil 
synchron damit läuft. In diesem Fall ist es nicht 
nötig, einen Einfügepunkt oder eine Selektion in 
einer Spur festzulegen, um einen Startpunkt zu 
bestimmen.

Record Online at Insertion/Selection – diese 
Option veranlasst den Beginn der Online-
Aufnahme an der Stelle, an der Sie den 
Einfügepunkt in der Spur positioniert haben. 
Die Aufnahme wird dann so lange fortgesetzt, 
bis Pro Tools keinen Timecode mehr empfängt. 
Wenn Sie eine Timeline-Auswahl vornehmen, 
entspricht die Dauer der Online-Aufnahme von 
Pro Tools der Länge dieser Auswahl. 

Erzeugen von Timecode
Mit SYNC HD kann Pro Tools SMPTE- und 
MIDI-Timecode (MTC) erzeugen. Ohne 
SYNC HD kann Pro Tools lediglich MTC 
erzeugen. In diesem Fall fungiert Pro Tools als 
Master-Synchronisationsquelle mit anderen 
Geräten als Slave (folgend).

So erzeugen Sie MIDI-Timecode in Pro Tools:

1 Wählen Sie Setup > Peripherals und 
anschließend die Synchronization-
Registerkarte.

2 Wählen Sie unter der MTC Generator Port-
Einstellung den MIDI-Ausgang, über den 
MIDI-Timecode (MTC) übertragen 
werden soll.

3 Wählen Sie im Transport-Fenster-Menü 
(oder im Menü des Edit-Fensters) die 
Synchronization-Option.

4 Klicken Sie auf die Gen MTC-Schaltfläche, 
sodass sie leuchtet.

5 Starten Sie die Wiedergabe.

So erzeugen Sie Timecode mit SYNC HD:

1 Verbinden Sie den LTC-Ausgang von 
SYNC HD mit dem SMPTE-Eingang der als 
Slave betriebenen Geräte. Wenn Sie ein Slave-
Gerät verwenden, das MTC erkennt, verbinden 
Sie den MTC OUT-Anschluss von SYNC HD 
mit dem MIDI IN-Anschluss des Slave-Geräts. 

2 Vergewissern Sie sich, dass Ihr SYNC HD 
eingeschaltet ist.

3 Wählen Sie in Pro Tools Setup > Peripherals 
und klicken Sie auf die Synchronization-
Registerkarte.

4 Wählen Sie im Synchronization Device-
Abschnitt der Synchronization-Registerkarte 
die Enable SYNC Peripheral-Option.

5 Klicken Sie auf OK, um das Peripherals-
Dialogfeld zu schließen.

Auswählen des „MTC Generator Port“

Transport-Fenster, „Gen MTC“ aktiviert
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6 Wählen Sie Setup > Session und legen Sie 
mithilfe der Timecode Rate-Einstellung die 
gewünschte Framerate fest.

7 Wählen Sie im Session Setup-Fenster im SYNC 
Setup-Abschnitt mit dem Clock Reference-
Selektor eine Clock-Referenz aus. Nicht alle 
Clocks stehen für alle Samplerates zur 
Verfügung. Siehe „External Clock Sources“ auf 
Seite 1204.

8 Wählen Sie im Transport-Fenster-Menü 
(oder im Menü des Edit-Fensters) die 
Synchronization-Option.

9 Wählen Sie eine der folgenden Optionen:

• Gen MTC zum Erzeugen von MIDI-Timecode

• Gen LTC zum Erzeugen von linearem Timecode

10 Starten Sie die Wiedergabe.

Pro Tools erzeugt nun Timecode und gibt diesen 
über SYNC HD aus.

Einschränkungen für SYNC HD, 
wenn es synchron mit 
Videoeingabe oder -referenz läuft
Ein SYNC HD kann Timecode mit jeder 
Framerate erzeugen, wenn es stabil synchron mit 
einer Videoreferenz oder einen Videoeingang 
läuft, ungeachtet der Framerate des eingehenden 
Videoreferenzsignals. Wenn Sie jedoch Timecode 

erzeugen möchten und dabei eine Framerate 
verwenden, die nicht mit der des Videosignals 
übereinstimmt, werden die Frameränder in der 
Pro Tools-Session (und die Frame-Ränder des 
Timecodes, den Sie erzeugen) nicht an den 
Rändern der Video-Frames ausgerichtet.

MIDI-Maschinensteuerung
Mithilfe der MIDI-Maschinensteuerung (MIDI 
Machine Control, MMC) ist Pro Tools in der Lage, 
Positionsinformationen an externe Geräte zu 
übermitteln und deren Laufwerke zu steuern. 

Steuerung externer Geräte 
mit MMC
Jedes Gerät, das Maschinensteuerung (MMC) 
unterstützt, kann direkt von Pro Tools aus 
gesteuert werden. Als Clock-Master kann das 
Gerät selbst oder Pro Tools dienen.

Die von Pro Tools unterstützten externen Geräte 
arbeiten ausschließlich mit einer Open Loop-
Kommunikation. Das bedeutet, dass 
Steuerbefehle, die direkt über das empfangende 
Gerät ausgeführt werden, nicht an Pro Tools 
weitergegeben werden, solange Pro Tools als 
Transport-Master fungiert. Stattdessen können Sie 
das Transport-Popup-Menü dazu verwenden, 
das externe Gerät (unter MMC im Popup-Menü) 
auszuwählen, und es dann mit den Pro Tools-
Transport-Steuerelementen steuern. 

Transport-Fenster, Synchronisations-Optionen

Drücken Sie Befehl + Ctrl + J (Mac) 
oder Strg + Windows + J (Windows), 
um das Erzeugen von LTC (GEN LTC) 
an- oder abzuschalten.

Wenn Timecode-Rates inmitten einer Session 
geändert werden, müssen zahlreiche 
SMPTE-/MIDI-Timecode-Wandler aus- und 
wieder eingeschaltet werden, damit die neue 
Framerate erkannt wird.
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Pro Tools bietet keine Unterstützung der 
ferngesteuerten Scharfschaltung für Spuren von 
externen Geräten, die mit MMC gesteuert werden. 
Sie müssen diese Spuren manuell am Gerät für die 
Aufnahme scharfschalten. 

Aktivierung der MIDI-
Maschinensteuerung in 
Pro Tools

Pro Tools als MMC-Master
Wenn Pro Tools als Master fungiert, sendet es 
MMC-Befehle an das Slave-Gerät und empfängt 
MTC-Informationen von diesem.

So verwenden Sie ein externes Gerät als Slave von 
Pro Tools mithilfe der MIDI-Maschinensteuerung:

1 Verbinden Sie einen MIDI Out-Port Ihres 
Pro Tools-MIDI-Interface mit dem 
entsprechenden Anschluss des Slave-Geräts.

2 Verbinden Sie den MTC Out-Port des Slave-
Geräts mit einem MIDI In-Port Ihres Pro Tools-
MIDI-Interface.

3 Wählen Sie in Pro Tools Setup > Peripherals 
und klicken Sie auf die Synchronization-
Registerkarte.

4 Heben Sie die Auswahl für Enable SYNC 

Peripheral auf, falls diese Option aktiviert ist.

5 Wählen Sie aus demMTC Reader Port-Popup-
Menü den MIDI In-Port, an den das Slave-
Gerät angeschlossen wurde (die Quelle der 
MTC-Informationen des Slave-Geräts). 

6 Klicken Sie im Peripherals-Dialogfeld auf die 
Machine Control-Registerkarte.

7 Wählen Sie im MIDI Machine Control 
(Master)-Abschnitt Enable.

8 Wählen Sie im MIDI Machine Control 
(Master)-Abschnitt den MIDI Out-Port aus, 
an den das Slave-Gerät über das Popup-Menü 
angeschlossen wurde.

9 Legen Sie im Feld „ID“ die MMC-ID-Nummer 
fest, über die diese Informationen gesendet 
werden. 

MMC-Befehle enthalten eine ID-Nummer, die 
festlegt, welche Maschine mit dem MMC-Befehl 
angesprochen werden soll. Es gibt 128 MMC-ID-
Nummern, von 0 bis 127. Die Standard-ID-
Nummer 127 ist eine Spezialeinstellung, die an 
alle 128 MMC-IDs sendet. Mit der Einstellung 
127 sendet Pro Tools MMC-Befehle an alle 
MMC-IDs. 

10 Legen Sie eine Vorlaufzeit für Ihr MMC-Slave-
Gerät fest. Der Vorlauf (Pre-Roll) ist 
notwendig, um dem Gerät genügend Zeit zu 
geben, stabil snynhron mit dem von Pro Tools 
übertragenen Timecode zu laufen. Der Wert 
dafür ist von Gerät zu Gerät verschieden. Wenn 
die Vorlaufzeit nicht ausreichend lang ist, 
läuft das Gerät möglicherweise erst nach 
der aktuellen Timecode-Markierung stabil 
synchron.

Die MachineControl-Option unterstützt die 
ferngesteuerte Scharfschaltung von Spuren 
mit Sony 9-Pin- und V-LAN-kompatiblen 
Geräten. Siehe „Ferngesteuerte Spuren-
Scharfschaltung“ auf Seite 1223.

Auswählen des MIDI Out-Port für MMC
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11 Klicken Sie auf OK, um das Peripherals-
Dialogfeld zu schließen.

12 Klicken Sie im Pro Tools-Transport-Fenster mit 
der rechten Maustaste auf die Online-
Schaltfläche und wählen Sie Transport > MMC.

Pro Tools kann jetzt das Laufwerk des 
ausgewählten Geräts steuern und als Clock-Master 
fungieren.

13 Damit das Pro Tools-Laufwerk dem 
Wiedergabepunkt des Slave-Geräts folgt, 
klicken Sie auf die Online-Schaltfläche im 
Transport-Fenster, sodass sie blau blinkt.

Pro Tools als MMC-Slave
Wenn Pro Tools als Slave fungiert, empfängt es 
MMC-Befehle vom Master-Gerät und sendet 
MTC-Informationen an das Slave-Gerät zurück.

So verwenden Sie Pro Tools als Slave eines 
externen Geräts mithilfe der MIDI-
Maschinensteuerung:

1 Verbinden Sie einen MIDI-Eingang Ihres 
Pro Tools-MIDI-Interface mit dem 
entsprechenden Anschluss des Slave-Geräts.

2 Verbinden Sie einen MIDI Out-Port Ihres 
Pro Tools-MIDI-Interface mit dem 
MTC In-Port des Master-Geräts.

3 Wählen Sie in Pro Tools Setup > Session.

4 Wählen Sie im Timecode Settings-Abschnitt 
des Session Setup-Fensters „Using MTC“. 

5 Wählen Sie Setup > Peripherals und 
anschließend die Synchronization-
Registerkarte. 

6 Heben Sie die Auswahl für Enable SYNC 

Peripheral auf, falls es aktiviert ist.

7 Wählen Sie aus dem MTC Generator Port-
Popup-Menü den MIDI Out-Anschluss, an den 
das Master-Gerät angeschlossen wurde (das 
Ziel der MTC-Informationen von Pro Tools). 

8 Klicken Sie im Peripherals-Dialogfeld auf die 
Machine Control-Registerkarte.

9 Wählen Sie im MIDI Machine Control (Slave)-
Abschnitt Enable.

10 Legen Sie im ID-Feld die MMC-ID-Nummer 
(Kanal) fest, über die diese Informationen 
empfangen werden. 

11 Klicken Sie auf OK, um das Peripherals-
Dialogfeld zu schließen.

Pro Tools reagiert jetzt auf MMC-Befehle von 
dem externen Gerät.

Auswählen von Transport > MMC 

Damit Pro Tools MMC-Befehle empfängt, 
muss die MMC-Quelle im MIDI Input 
Enable-Dialogfeld aktiviert werden. 
Weitere Informationen finden Sie unter 
„Aktivieren von Eingabegeräten“ auf 
Seite 480

Machine Control-Registerkarte im Peripherals-
Dialogfeld mit ausgewählter MIDI Machine Control 
Remote-Option
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Betreiben von MMC-Geräten 
über das Pro Tools-Transport-
Fenster 
Sie können das Pro Tools-Transport-Fenster als 
Fernbedienung für alle aktivierten Geräte 
(beispielsweise ein nicht lineares Video-Deck) 
verwenden. Richten Sie die aktivierten Geräte 
dazu so ein, dass sie die MMC-Adresse abhören. 
Das Transport-Fenster steuert dann den Transport 
in Pro Tools sowie aller Geräte im Slave-Betrieb. 

So steuern Sie externe Geräte über das Transport-
Fenster in Pro Tools:

 Klicken Sie im Transport-Fenster mit der 
rechten Maustaste auf die Online-Schaltfläche 
und wählen Sie Pro Tools oder MMC. 
Das aktivierte Gerät fungiert nun als 
Transport-Master.

• Wenn Pro Tools als Transport-Master gewählt 
ist, wird die Wiedergabeposition durch den 
Cursor auf dem Pro Tools-Bildschirm bestimmt. 

• Wenn MMC als Transport-Master gewählt ist, 
wird die Wiedergabeposition durch die 
Abspielposition des externen Geräts bestimmt. 

MMC-Transport-Einstellungen
Wenn Sie mit MMC arbeiten, können Sie auf der 
Synchronization Preferences-Registerkarte die 
folgenden Optionen für das Verhalten des 
Maschinentransports wählen.

Machine Chases Memory Location – wenn diese 
Option aktiviert ist, bewirkt das Navigieren an eine 
bestimmte Position in einer Session mithilfe einer 
Memory Location, dass das über die Maschine 
angesprochene Gerät ebenfalls diese Position 
anfährt. 

Machine Follows Edit Insertion/Scrub – ist diese 
Option ausgewählt, bewirkt das Navigieren zu 
einer bestimmten Stelle einer Session durch das 
Verschieben des Cursors oder mithilfe der 
Scrubbing-Funktion, dass das über die 
Maschinensteuerung angesprochene Gerät 
ebenfalls diesen Punkt anfährt.

Offline-Schalten von Geräten
Über das Transport Online-Rechtsklick-Menü 
können Sie MIDI- oder andere Geräte offline 
schalten.

So schalten Sie ein Gerät offline:

1 Klicken Sie auf den Transport Master-Selektor.

2 Klicken Sie unter Transport auf das Online-
Popup-Menü und deaktivieren Sie das Gerät 
(Machine oder MIDI): Die verfügbaren Geräte 
hängen vom aktuellen Transport-Master und 
davon ab, welche Geräte in Pro Tools 
eingerichtet wurden.

Auswählen des Transport-Masters

Deaktivieren von „Online > MMC“
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Um das Gerät wieder online zu schalten, aktivieren 
Sie seinen Eintrag im Online-Popup-Menü.

Minimum Sync Delay
Die Lock-Up-Verzögerung ist die anfängliche 
Verzögerungszeit, die alle Geräte in Ihrem System 
benötigen, bis Sie stabil synchron mit dem 
Timecode laufen. Dieser Wert variiert je nach 
Gerät. In Pro Tools wird die Verzögerungszeit auf 
der Synchronization-Registerkarte durch Eingabe 
eines Werts im Minimum Sync Delay-Feld 
eingestellt. Der niedrigste Wert ist 15 Frames. 
Sie sollten die kürzeste Verzögerungszeit ermitteln, 
mit der Ihre Geräte einwandfrei arbeiten können, 
und sie ins Minimum Sync Delay-Feld eingeben. 
Bei manchen Systemen mit MachineControl lässt 
sich die Verzögerungszeit drastisch verkürzen, 
wenn die Einstellung „Use Serial Timecode“ 
im Session Setup-Fenster aktiviert ist. (Für den 
seriellen Timecode müssen sowohl SYNC HD als 
auch externe Geräte stabil synchron mit der 
studioweiten Videoreferenz laufen.)

So legen Sie eine minimale 
Synchronisationsverzögerung fest:

1 Wählen Sie Setup > Preferences und 
anschließend die Synchronization-
Registerkarte.

2 Geben Sie im Minimum Sync Delay-Feld die 
Anzahl der Frames ein. 

3 Klicken Sie auf OK, um das Preferences-
Dialogfeld zu schließen. 

Konfigurieren der minimalen Verzögerungszeit 
für externe MMC-Geräte, die auf einen 
Taktgeber im Studio synchronisiert sind

Wenn Pro Tools über MMC ein auf einen 
Taktgeber im Studio synchronisiertes externes 
Gerät steuert, synchronisiert dieses Gerät zuerst 
mit der MMC-Position und danach mit der 
Farbbildfrequenz. In den Taktgebern in Ihrem 
Studio sind vier Frames vorgesehen, um das 
Einrasten auf die Farbbildfrequenz zu 
gewährleisten. Wenn der Wert im Minimum Sync 
Delay-Feld zu gering ist, um Synchronisation 
sowohl mit der MMC-Position als auch der 
Farbbildfrequenz zu erlauben, wird die 
Wiedergabe gestartet, bevor das Gerät synchron 
mit der Farbbildfrequenz läuft. In diesem Fall 
sollten Sie im Feld Minimum Sync Delay einen 
Wert festlegen, der größer ist als die Zeitspanne, 
die zum Herstellen der Synchronität mit der 
Farbbildfrequenz benötigt wird. In Verbindung 
mit SYNC HD gibt es dieses Problem nicht, 
weil das Gerät die Synchronität mit der MMC-
Position verliert, solange es nicht synchron zur 
Farbbildfrequenz läuft. 

Im Online-Popup-Menü werden nur Geräte 
angezeigt, die korrekt in Pro Tools 
eingerichtet wurden.

Zur Einrichtung von MIDI-Geräten siehe 
„Aktivierung der MIDI-Maschinensteuerung 
in Pro Tools“ auf Seite 1219.

Informationen zur Einrichtung anderer 
Geräte finden Sie im MachineControl-
Handbuch.
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Ferngesteuerte Spuren-
Scharfschaltung
Die MachineControl-Option für Pro Tools 
ermöglicht es Ihnen, Spuren auf unterstützten 9-Pin-
Geräten (bzw. nur für den Transport: V-LAN-
Geräten) für die Aufnahme ferngesteuert 
scharfzuschalten (Remote Track Arming). Ohne 
MachineControl unterstützt Pro Tools keine 
ferngesteuerte Scharfschaltung für Spuren von 
externen Geräten. Mit der MachineControl-Option 
kann Pro Tools in Verbindung mit Sony-9-Pin-
Geräten (oder V-LAN-Geräten nur für den 
Transport) als Master oder Slave betrieben werden. 
Zusätzlich erlaubt diese Option die ferngesteuerte 
Scharfschaltung von Spuren direkt aus Pro Tools.

Positionieren von Clips auf 
SMPTE-Frame-Positionen
Spotting ist der Vorgang, bei dem die Wiedergabe 
von Musik oder Soundereignissen mit bestimmten 
SMPTE-Frame-Positionen eines Films oder 
Videos verknüpft wird. Mit der Spot-Funktion 
positionieren Sie:

• ganze Clips, die vorher mit dem Time Grabber-
Tool ausgewählt wurden; wenn mehrere Clips 
selektiert werden, orientiert sich Pro Tools am 
ersten Clip in der Selektion

• eine bestimmte Position innerhalb eines Clips, 
indem Sie mit dem Selector-Tool auf diese Stelle 
klicken und anschließend Clip > Identify Sync 

Point wählen 

• Sessions oder Spuren, die vom Browser in die 
Timeline oder Clipliste der Session gezogen 
wurden 

Spot-Modus
Im Spot-Modus kann ein Clip in einer Spur schnell 
positioniert werden, indem Sie mit dem Time 
Grabber-Tool auf diesen Clip klicken. 

Alternativ können Clips auch aus einem 
Workspace-Browser oder aus der Clipliste auf eine 
Spur gezogen werden, während der Spot-Modus 
aktiv ist. 

Wählen Sie „Setup > Machine Track Arming 
Profiles“, um Ihr System zu konfigurieren, 
und wählen Sie „Window > Machine Track 
Arming“, um das Machine Track Arming-
Fenster anzuzeigen.

Drücken Sie Befehl + Wahl + Ctrl + J (Mac) 
oder Strg + Alt + Windows + J (Windows), 
um den Fernsteuerungsmodus zu aktivieren 
bzw. deaktivieren. Wenn Sie eine 
D-Command- oder D-Control-
Bedienoberfläche benutzen, verwenden Sie 
die 9-Pin Remote-Schaltfläche.

Informationen zum ferngesteuerten 
Scharfschalten von Spuren mit 
MachineControl finden Sie im 
MachineControl-Handbuch.
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Spot-Dialogfeld
Das Spot-Dialogfeld öffnet sich, wenn ein Clip auf 
eine Spur gezogen oder im Spot-Modus mit dem 
Time Grabber-Tool angeklickt wird. Die 
numerischen Felder fungieren sowohl als 
Datenanzeigen als auch als Steuerelemente für die 
Bearbeitung der aktuell ausgewählten Clips. 

Informationen in diesen Feldern werden in 
Abhängigkeit vom ausgewählten Time Scale-
Format als SMPTE-Timecode, 
„Minutes:Seconds“, „Feet.Frames“, Samples oder 
„Bars|Beats“ angezeigt.

Ein markiertes Zahlenfeld zeigt an, dass Daten 
eingegeben werden können. Durch Eingabe eines 
Werts in einem Feld können Sie ausgewählte 
Einstellungen auf die gewünschte zeitliche 
Position setzen. Wenn das Time Grabber-Tool 
aktiviert ist, stehen die Start-, Sync Point- und 
End-Felder für die Eingabe zur Verfügung. Nur 
das Start- oder End-Feld (je nachdem, wo Sie 
klicken) und das Duration-Feld sind aktiv, wenn 
eines der Trim-Tools aktiv ist (siehe „Trim-Tools 
im Spot-Modus“ auf Seite 1226).

Use Subframes-Option
Ein Subframe ist ein Hundertstel eines Frames. 
Die Use Subframes-Option ermöglicht es, diese 
kleinere Einheit zu verwenden und so größere 
Genauigkeit zu erzielen. Wenn diese Option 
aktiviert ist, erscheint rechts neben der SMPTE-
Zeitanzeige (Stunden:Minuten:Sekunden:Frames) 
ein weiteres Zeitfeld. Setzen Sie einen Punkt (.) 
zwischen Frames und Subframes, um diese Werte 
voneinander zu trennen.

Spot-Dialogfeld

Wenn Sie die SMPTE-Werte im Spot-
Dialogfeld um eine bestimmte Anzahl von 
Frames erhöhen oder verringern möchten, 
drücken Sie auf dem Ziffernblock die Plus- 
(+) oder Minus-Taste (–), geben Sie eine 
Zahl ein und drücken Sie die Enter-Taste.

Zusätzliches Zeitfeld bei aktivierter Use Subframes-
Option 

Im Feld zur Anzeige des aktuellen Timecodes 
(Current Timecode) ist das Zusatzfeld für 
Subframes nicht verfügbar.
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Erfassen von Timecode
Pro Tools gibt Ihnen außerdem die Möglichkeit, 
in diesem Dialogfeld während der Wiedergabe 
Frame-Positionen zu erfassen. Dazu müssen Sie, 
während Pro Tools gültigen Timecode empfängt, 
einfach die Enter-Taste auf dem Ziffernblock 
drücken oder auf die Current Timecode-
Schaltfläche klicken. Wenn Sie mit VITC arbeiten, 
können Sie die SMPTE-Position eines 
Videorekorders auch im Pausenmodus oder im 
Bildsuchlauf präzise erfassen.

Wenn Timecode als Zeitformat für die Zeitskala 
aktiviert ist, kann der eingehende Timecode durch 
Drücken der Enter-Taste auf dem Ziffernblock 
erfasst werden. Wenn „Bars|Beats“ als Zeitformat 
für die Zeitskala gewählt wurde, wird durch 
Drücken der Enter-Taste auf dem Ziffernblock der 
nächstgelegene Takt erfasst.

Während „Capture Timecode“ mit freilaufendem 
linearen Timecode (LTC) oder VITC zum Einsatz 
kommen kann, können die Frame-Adressen eines 
angehaltenen Frames nur mit VITC erfasst werden. 

SYNC HD kann VITC lesen. Mit MachineControl 
und SYNC HD kann auch serieller Timecode 
gelesen werden.

So positionieren Sie einen Clip im Spot-Modus auf 
einem bestimmten SMPTE-Frame:

1 Aktivieren Sie den Spot-Modus.

2 Wählen Sie unter „Main Time Scale“ 
die Timecode-Einstellung. (Siehe „Einstellen 
einer SMPTE-Startzeit für eine Session (Start-
Frame)“ auf Seite 1210.)

3 Identifizieren Sie die SMPTE-Frame-Position, 
an der die Wiedergabe Ihres Clips beginnen 
soll, indem Sie das Videodeck an der Position 
des betreffenden Frames anhalten. 

4 Klicken Sie mit dem Time Grabber-Tool einen 
Clip in einer Spur oder in der Clipliste an und 
ziehen Sie ihn in eine Spur. Das Spot-
Dialogfeld wird geöffnet.

5 Geben Sie eine SMPTE-Frame-Position ein. 
Dazu haben Sie folgende Möglichkeiten: 

• Wenn Sie mit VITC arbeiten, können Sie die 
Enter-Taste auf dem Ziffernblock drücken oder 
auf die Current Timecode-Schaltfläche klicken, 
um die aktuelle SMPTE-Position des auf Pause 
geschalteten Videorekorders zu übernehmen.

• Wenn Sie mit LTC arbeiten und für die Zeitskala 
das Zeitformat „Timecode“ gewählt wurde, 
drücken Sie die Enter-Taste auf dem 
Ziffernblock, um den eingehenden Timecode zu 
erfassen. Wenn „Bars|Beats“ als Zeitformat für 
die Zeitskala gewählt wurde, drücken Sie die 
Enter-Taste auf dem Ziffernblock, um den 
nächstgelegenen Takt zu erfassen.

6 Wenn Sie den Clip im Online-Betrieb 
aufgezeichnet haben, können Sie die 
ursprüngliche SMPTE-Frame-Position dieser 
Aufzeichnung mit der Original Time Stamp-
Schaltfläche erneut abrufen und dann eingeben. 
Auf die gleiche Weise können Sie auf einen 
benutzerdefinierten Zeitstempel zugreifen, 
indem Sie auf die User Time Stamp-
Schaltfläche klicken. Weitere Hinweise finden 
Sie unter „Zeitstempelfunktion“ auf Seite 1226.

7 Klicken Sie zum Schließen des Dialogfelds auf 
OK. Der Clip wird an der ausgewählten 
SMPTE-Frame-Position platziert. Während der 
Online-Session löst diese Frame-Adresse die 
Wiedergabe des Clips aus.

Um den Remote-Modus mit MachineControl 
verwenden zu können, brauchen Sie einen 
dafür geeigneten seriellen Port. Eine 
vollständige Liste der geeigneten Ports 
finden Sie unter www.avid.com.



Pro Tools-Referenzhandbuch1226

Clips automatisch 
positionieren
Durch die Auto-Spot Clips-Option wird das 
Positionieren von Clips in Pro Tools weiter 
vereinfacht. Wenn Sie VITC oder 
MachineControl-Software verwenden und diese 
Option aktiviert ist, können Sie Ihr Video an der 
geeigneten SMPTE-Frame-Position anhalten und 
dann mit dem Grabber auf einen Clip klicken, 
wodurch der Clip automatisch dem aktuellen 
Timecode-Bereich zugewiesen wird. 

Sie können auch die serielle Timecode-Funktion 
der MachineControl-Software zur automatischen 
Positionierung verwenden, indem Sie 
MachineControl aktivieren und seriellen 
Timecode im Peripheriegerät aktivieren. 

Automatische Positionierung von Clips

1 Wählen Sie Options > Auto-Spot Clips.

2 Wenn Sie VITC verwenden, bestimmen Sie die 
SMPTE-Frame-Position, an der die Wiedergabe 
Ihres Clips starten soll, indem Sie das 
Videodeck an der Position des betreffenden 
Frames anhalten. 

3 Klicken Sie den Clip mit dem Time Grabber-
Tool an. Der Clip wird automatisch an der 
aktuellen Timecode-Position (oder 
Geräteposition) platziert.

Trim-Tools im Spot-Modus
Sie können das Spot-Dialogfeld dazu verwenden, 
Clips inklusive der Zeiten für Anfang, Ende und 
Länge zu trimmen und darüber hinaus den Bezug 
auf Timecode-Adressen festzulegen. Wenn Sie im 
Spot-Modus einen Clip mit einem der Trim-Tools 
anklicken, öffnet sich das Spot-Dialogfeld. Geben 
Sie entsprechende Werte in die Felder „Start“ bzw. 
„End“ und „Duration“ ein, um genau festzulegen, 
an welcher Position der Anfang oder das Ende des 
Clips getrimmt werden soll. Hierdurch kann die 
Länge eines Clips an einen bestimmten visuellen 
Punkt angepasst werden. 

Das Trimmen eines Clips, der einen Sync-
Punkt enthält (siehe „Festlegen eines 
Synchronisationspunkts“ auf Seite 1228), 
hat keine Auswirkungen auf die SMPTE-
Position des Sync-Punkts, sofern das Trimmen 
nicht über den Sync-Punkt hinausgeht.

Zeitstempelfunktion
Pro Tools versieht jeden Clip, der im Online-
Betrieb aufgezeichnet wurde, mit einem 
Zeitstempel (Time Stamp). Dies ist die Kennung 
der SMPTE-Zeit, an der das Audiomaterial 
ursprünglich aufgezeichnet wurde. Sie können die 
ursprüngliche SMPTE-Zeit für einen Clip abrufen, 
indem Sie im Spot-Dialogfeld auf die Schaltfläche 
„Original Time Stamp“ klicken.

Sie können einen Clip im Spot-Modus auch an 
einem beliebigen benutzerdefinierten SMPTE-
Zeitstempel positionieren, der über den Time 

Stamp-Befehl im Cliplisten-Popup-Menü definiert 
wurde. Wenn dem Clip durch diesen Befehl ein 
neuer Zeitstempel zugewiesen wurde, können Sie 
ihn durch Klicken auf die User Time Stamp-
Schaltfläche an der benutzerdefinierten SMPTE-
Position positionieren.

Durch Anklicken eines Clips mit einem der 
Trim-Tools können Sie den Clip auf die 
aktuelle Timecode-Position trimmen.

Automatisch positionierte Clips werden 
durch ihre Startzeit erkannt, es sei denn, Sie 
haben einen Sync-Punkt festgelegt (siehe 
„Festlegen eines Synchronisationspunkts“ 
auf Seite 1228). Falls der Clip einen Sync-
Punkt enthält, wird der Clip an diesem 
positioniert. 
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Show Original Timecode in Clips
Über diesen Befehl werden die ursprünglichen, mit 
einem Zeitstempel versehenen SMPTE-Zeiten in 
allen aktuell in Spuren positionierten Clips 
angezeigt. Diese SMPTE-Frame-Adresse steht für 
die zeitliche Position, an der der Clip ursprünglich 
mit Pro Tools im Online-Betrieb aufgenommen 
wurde, und entspricht somit nicht zwangsläufig 
der aktuellen SMPTE-Position in einer Spur.

So blenden Sie ursprüngliche Zeitstempel in Clips 
ein oder aus:

 Aktivieren oder deaktivieren Sie View > Clip > 

Original Time Stamp.

Erstellen eines 
benutzerdefinierten 
Zeitstempels 
Mit dem Time Stamp-Befehl im Cliplisten-Popup-
Menü können Sie einen benutzerdefinierten 
SMPTE-Zeitstempel erstellen. Mit diesem Befehl 
können Sie einen oder mehrere Clips selektieren 
und den entsprechenden SMPTE-Zeitstempel neu 
definieren. Der ursprüngliche und 
benutzerdefinierte Benutzerstempel wird mit der 
Session gespeichert.

Nach der ersten Audioaufnahme entspricht der 
benutzerdefinierte noch dem ursprünglichen 
Zeitstempel; Sie können ersteren jedoch jederzeit 
mit dem Time Stamp-Befehl ändern. Diese 
Funktion erweist sich vor allem für die 
Postproduktion als nützlich, in der der SMPTE-
Timecode auf Videoarbeitsbändern sich häufig 
von einer Bearbeitung zur nächsten ändert.

Versehen von einem oder mehreren Clips mit 
einem Zeitstempel mit einer neuen SMPTE-Frame-
Adresse

1 Wählen Sie in einer Spur den Clip, den Sie mit 
einem Zeitstempel versehen möchten.

2 Wählen Sie im Clip List-Menü den Time 

Stamp-Befehl.

3 Geben Sie einen neuen SMPTE-Timecode ein. 
Dafür haben Sie folgende Möglichkeiten: 

• Geben Sie die Zahlen (mithilfe der Pfeiltasten) 
manuell ein. 

• Klicken Sie auf die Current Timecode-
Schaltfläche (oder drücken Sie die Enter-Taste 
auf dem Ziffernblock), um die eingehende 
Timecode-Adresse zu erfassen.

• Klicken Sie auf die Current Selection-
Schaltfläche, um die Startzeit der aktuellen 
Selektion auf dem Bildschirm einzugeben.

4 Klicken Sie auf OK.

Dieser Befehl kann im „Batch-Modus“ zum 
Einsatz kommen, um neue Zeitstempel für 
mehrere Clips gleichzeitig festzulegen. Dazu 
suchen Sie mehrere Clips aus und wählen 
anschließend den Time Stamp-Befehl. Es öffnen 
sich nacheinander Dialogfelder für jeden Clip, 
in die Sie im Handumdrehen neue Werte eintragen 
können.

User Time Stamp-Dialogfeld
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Nach der Eingabe können die vom Anwender 
festgelegten Zeitstempel in allen aktuell Spuren 
zugewiesenen Clips angezeigt werden. 

So blenden Sie benutzerdefinierte Zeitstempel in 
Clips ein oder aus:

 Aktivieren oder deaktivieren Sie View > Clip > 

User Time Stamp.

Festlegen eines 
Synchronisationspunkts
Mit dem Identify Sync Point-Befehl in Pro Tools 
können Sie einen bestimmten Punkt innerhalb 
eines Clips für das Spotting von Audio festlegen. 

Stellen Sie sich folgende Situation für die 
Positionierung von Soundeffekten vor: Sie haben 
einen einzelnen Soundeffekt, der aus dem 
Zuschlagen einer knarrenden Tür und nachfolgend 
aus einigen Sekunden Echo besteht. Die Sequenz, 
in der die Tür ins Schloss fällt und die genau mit 
dem entsprechenden Bild übereinstimmen muss, 
befindet sich nicht ganz am Anfang und auch nicht 
ganz am Ende der Audiodatei. Sie liegt irgendwo 
in der Mitte, wodurch die Verknüpfung von Bild 
und Ton erschwert wird. Mit dem Identify Sync 

Point-Befehl können Sie nun in dem Clip einen 
Punkt erstellen und diesen Punkt mit einem 
SMPTE-Frame synchronisieren. 

Zur Erstellung eines Sync-Punkts in einem Clip:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie mit dem Selector-Tool an die Stelle 
des Clips, die Sie mit einer SMPTE-Frame-
Position synchronisieren möchten. 

• Halten Sie die Nach-unten-Pfeiltaste gedrückt 
und spielen Sie das Material ab. 

2 Wählen Sie Clip > Identify Sync Point. 
Die aktuelle SMPTE-Zeit wird automatisch 
an der SMPTE-Position des Sync-Punkts 
eingegeben. Ein kleiner nach unten weisender 
Pfeil erscheint am unteren Rand des Clips und 
die Position des Sync-Punkts wird mit einer 
vertikalen, hellgrauen Linie markiert.

Fehlerbehebung bei der 
SMPTE-Synchronisation
Falls Ihnen die SMPTE-Synchronisation Probleme 
bereitet, können Sie an Ihrem System eine 
Fehlerbehebung vornehmen und allgemeine 
Probleme lösen. 

Bespielen Sie die Bänder mit 
SMPTE vor der Aufnahme
Alle Bänder in Ihrem System (sowohl Audio als auch 
Video) müssen zunächst mit SMPTE-Timecode 
bespielt werden, bevor Sie auf diese oder in 
Pro Tools aufnehmen. Andernfalls scheint Ihr 
System zwar fehlerfrei zu arbeiten, eine präzise 
Synchronisation lässt sich aber nicht erreichen. 
Je länger die Bandmaschinen und Pro Tools im 
Verbund laufen, desto stärker laufen Sie auseinander.

Das gleiche Problem tritt auf, wenn Audio ohne eine 
getaktete SMPTE-Quelle in Pro Tools 
aufgenommen wird (etwa, wenn es bereits vor 
der aktuellen Session aufgenommen wurde). 
Das Audiomaterial kann nicht präzise mit analogen 
Bandmaschinen oder Videogeräten synchronisiert 
werden, wenn es ohne Referenz auf einen SMPTE-
Timecode der analogen Bandmaschine bzw. 
des Videogeräts aufgenommen wurde.

Weitere Informationen zu Sync-Punkten 
finden Sie unter „Sync-Punkte“ auf 
Seite 862.

Sync-Punkt in einem Audioclip
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Takten Sie alle Komponenten im 
System gleichmäßig
Stellen Sie beim Aufzeichnen von Timecode 
sicher, dass der Timecode-Generator und der 
Videorekorder den Takt von demselben 
Quarzoszillator beziehen. Wenn Sie 
beispielsweise Timecode im 29,97-Drop Frame-
Format auf einen Videorekorder aufzeichnen, 
müssen der SMPTE-Generator und der 
Videorekorder den Takt von demselben Black 
Burst-Generator oder einem ähnlichen 
Taktgenerator in Ihrem Studio beziehen. Während 
der Wiedergabe sollte die Master-Maschine auf 
den Black Burst- oder House Sync-Signalgeber in 
Ihrem Studio getaktet bleiben. 

Dadurch wird sichergestellt, dass die Aufnahme- 
und Wiedergabedurchläufe Ihres Bandes 
miteinander kompatibel sind, auch wenn das Band 
in anderen Studios auf anderen Geräten 
wiedergegeben wird. Dies bedeutet auch, dass bei 
der Wiedergabe eines mit Timecode versehenen 
Bands das Wiedergabedeck auf die gleiche 
Synchronisationsrate getaktet werden sollte wie 
das Aufnahmedeck zum Zeitpunkt der 
Aufzeichnung des Timecodes. Ein 
Audiobandlaufwerk sollte bei der Aufzeichnung 
von Timecode „freilaufend“ sein und keine 
Taktgeber haben; bei der Wiedergabe sollte es sich 
aber auf einen Synchronizer beziehen, der auf 
einen Taktgeber im Studio getaktet ist.

Stellen Sie die tatsächliche 
Framerate der Medien fest
Wenn Sie Ihre Medien nicht selbst aufnehmen, 
sondern von einer Produktionsfirma beziehen, 
müssen Sie sicherstellen, dass die angegebene 
Framerate auch mit der auf dem Band 
übereinstimmt. Zahlreiche Timecode-Formate 
verwenden trotz gleicher Frame-Anzahl (etwa 
23,976 fps und 24 fps) leicht unterschiedliche 
Frame-per-Second-Raten (fps).

Ein SYNC HD (sowie einige Geräte von 
Drittherstellern) kann zur Bestimmung der 
Framerate verwendet werden.

29.97 fps-Non-Drop-Rate wird 
nicht erkannt
29,97 fps Non-Drop ist etwas langsamer als das 
Timecode-Format 30 fps Non-Drop. Bei 
Farbvideo im Format 29,97 fps Non-Drop stimmt 
jedes Videobild mit jedem SMPTE-Frame 
überein, eine Codierung mit Drop-Frame ist nicht 
notwendig. Dadurch wird das Umrechnen von 
Timecode stark vereinfacht, weil keine Frame-
Adressen weggelassen werden.

Leider erkennen einige Hardware- und 
Softwaregeräte das 29,97-Non-Drop-Format nicht 
als eigenständige Framerate. So erkennen die 
Standard-SMPTE-to-MTC-Wandler dieses 
Format nicht. Sie müssen den Wandler so 
einstellen, dass dieser stattdessen 30 fps Non-Drop 
erwartet. Viele SMPTE-verarbeitende Geräte 
können das 29,97-Non-Drop-Format dennoch 
auslesen, auch wenn sie darauf eingestellt wurden, 
30 fps Non-Drop zu erwarten.

Jedes SMPTE-Lesegerät, das Timecode-Adressen 
für Echtzeitberechnungen verwendet (wie das bei 
Pro Tools der Fall ist, wenn es versucht, zu starten 
und sich mit SMPTE zu synchronisieren), braucht 
die Information, dass das Frame-Format 29,97 fps 
und nicht 30 fps beträgt. Da Pro Tools diese 
Auswahl zwischen den Frame-Formaten anbietet, 
stellt dies kein Problem dar. Das eigentliche 
Problem besteht darin, dass viele Anwender nicht 
sicher zwischen den 29,97 und 30 fps-Formaten 
unterscheiden können.

Hinzu kommt, dass einige Produktionsfirmen auf 
29,97 fps formatierte Videoarbeitsbänder 
ausgeben, diese Bänder jedoch mit „30 fps NTSC“ 
beschriften. Damit ist eigentlich aber 29,97 fps 
Non-Drop gemeint.
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Wenn Sie nun das Band erhalten, wissen Sie 
womöglich nicht, in welchem Format es 
aufgezeichnet wurde. Wenn Sie 29,97 Non-Drop 
einspeisen, obwohl Pro Tools auf 30 fps Non-
Drop eingestellt ist, kommt es zu Fehlern im 
Timing von ca. 1,8 Frames pro Minute. Dadurch 
wird die Wiedergabe von Audio nicht mehr 
synchron zum Video ausgelöst.

Verwenden Sie einen 
gleichbleibenden Taktgeber
Mediendateien sollten so weit als möglich mit 
demselben Sync-Referenzsignal wiedergegeben 
werden, mit dem sie aufgezeichnet wurden. 
Dadurch wird die größtmögliche 
Übereinstimmung zwischen den Samplerates von 
Aufnahme und Wiedergabe gewährleistet. 
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Geschwindigkeitskorrektur für Film, NTSC-Video und 
PAL-Video

Framerates, Filmabtaster-Übertragungen und relative Wiedergabegeschwindigkeiten

 

 

 

schneller

langsamer

25 fps

x 104,1667 % 
beschleunigt (4 % Pull-Up)

x 96,0 % verlangsamt 
(4 % Pull-Down)

24 fps 30 fps

x 100,1 % beschleunigt 
(0,1 % Pull-Up)

x 99,9 % verlangsamt 
(0,1 % Pull-Down)

x 100,1 % 
beschleunigt 
(0,1 % Pull-Up)

x 99,9 % 
verlangsamt 

(0,1 % Pull-Down)

23,976 fps 29,97 fps

gleiche Programmgeschwindigkeit, 
weniger Frames pro Sekunde

gleiche Programmgeschwindigkeit, 
mehr Frames pro Sekunde

Filmabtaster

Filmabtaster
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Samplerate-Konvertierung mit Quell-Samplerates bei Pull-Up/Pull-Down-Einstellung

Von: Auf: Pull: Source Sample Rate

NTSC-
Video

PAL +0,1 %, dann 
+4,1667 %

45983 50050 91967 100100 – –

Film PAL +4,1667 % 45938 50000 91875 100000 – –

NTSC-
Video

Film +0,1 % 44144 48048 88288 96096 176576 192192

Film NTSC-
Video

–0,1 % 44056 47952 88112 95904 176224 191808

PAL Film –4,0 % 42336 46080 84672 92160 – –

PAL NTSC-
Video

–4,0 %, dann 
0,1 %

42294 46034 84587 92068 – –

NTSC-Video = 23,976/29,97 fps
Film = 24/30 fps
PAL = 25 fps

Destination Sample Rate

44100 48000 88200 96000 176400 192000

Samplerate-Konvertierung mit Ziel-Samplerates bei Pull-Up/Pull-Down-Einstellung

NTSC-Video = 23,976/29,97 fps
Film = 24/30 fps
PAL = 25 fps

Source Sample Rate

44100 48000 88200 96000 176400 192000

Von: Auf: Pull: Destination Sample Rate

NTSC-
Video

PAL +0,1 %, dann 
+4,1667 %

42294 46034 84587 92068 – –

Film PAL +4,1667 % 42336 46080 84672 92160 – –

NTSC-
Video

Film +0,1 % 44056 47952 88112 95904 176224 191808

Film NTSC-
Video

–0,1 % 44144 48048 88288 96096 176576 192192

PAL Film –4,0 % 45938 50000 91875 100000 – –

PAL NTSC-
Video

–4,0 %, dann 
0,1 %

45983 50050 91967 100100 – –
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Kapitel 51: Arbeit mit tragbaren Rekordern 
und Pro Tools

Mit Pro Tools HD können Sie Mehrkanal-
Audiodateien und Metadaten importieren, die mit 
einem tragbaren Rekorder aufgenommen wurden. 

Begriffe zu tragbaren 
Rekordern und Produktions-
Workflows
Bevor Sie in Pro Tools HD mit tragbaren 
Rekordern arbeiten, sollten Sie sich mit den 
häufigsten Begriffen zu tragbaren Rekordern und 
Produktion vertraut machen.

Begriffe zu tragbaren Rekordern
Das folgende Glossar bezieht sich auf tragbare 
Rekorder im Allgemeinen.

Metadaten

Der Begriff Metadaten bezeichnet Folgendes:

• Informationen zu einer Mediendatei; dazu 
können Szene, Take, Samplerate, Bittiefe, 
Namen externer Clips, der Name des 
Videobands, von dem die Mediendatei erfasst 
wurde, und sogar Timecode-Werte zählen.

• In Pro Tools-Sessions oder anderen Sequenzen 
eingebettete Informationen, auch darüber, 
welche Dateien verwendet werden, wo sie in der 
Timeline erscheinen und über Automation.

• Bei AAF- oder OMF-Sequenzen: Informationen 
zur Automation oder zum Clip-Gain.

Digitale tragbare Rekorder

Ein tragbarer Rekorder, auch bekannt als digitales 
Aufnahmegerät, ist ein Gerät, das der Set-
Tonmeister bei Film- oder Videoaufnahmen für 
eine Mehrspuraufnahme über mehrere 
Mikrofoneingänge gleichzeitig benutzt.

Je nach den technischen Möglichkeiten und 
Einstellungen eines tragbaren Rekorders können 
Mehrspuraufnahmen eine oder mehrere (bis zu 32) 
Spuren beinhalten. Sie werden als monofone oder 
polyfone Audiodatei auf Festplatte, DVD-RAM 
oder Flash-Laufwerken gespeichert.

Bei Mehrkanalaufnahmen, die mit einem 
tragbaren Rekorder erstellt werden, sollten Anfang 
und Ende mit Zeitstempeln – SMPTE-Timecode 
oder linearem Timecode (LTC) – kodiert werden. 
Bei den meisten tragbaren Rekordern ist die 
manuelle Eingabe von Metadaten möglich, 
darunter Kanalname bzw. -nummer, Szene, Take, 
Circled Take, User Bits und mehr.

Pro Tools kann monofone und polyfone Dateien 
importieren ebenso wie bestimmte Arten von 
Metadaten, die auf tragbaren Rekordern 
eingegeben wurden. 
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Set-Tonmischung

Für jede Mehrkanal-Aufnahme mit einem 
tragbaren Rekorder kann der Set-Tonmeister eine 
Set-Tonmischung vornehmen, die entweder einen 
Musterkanal oder eine Mischung anderer 
ausgewählter Kanäle der Aufnahme umfasst.

Die Set-Tonmischung soll als allgemeine 
Bezugsgröße für sämtliche Tonaufnahmen 
innerhalb einer bestimmten Mehrkanalaufnahme 
dienen. Typischerweise wird sie am Avid-
Schnittplatz beim Erstellen einer Sequenz benutzt.

Broadcast WAV-Dateien (BWF)

Unter Broadcast WAV-Dateien (oder Broadcast 
WAF Files, BWF) versteht man WAV-Dateien, 
die einen sogenannten „BEXT Chunk“ enthalten, 
aber die .wav-Dateinamenserweiterung 
beibehalten. Broadcast WAV-Dateien können 
sowohl einen BEXT- als auch iXML-Chunk 
enthalten oder auch nur einen BEXT-Chunk.

BEXT und iXML-Chunks

BEXT und iXML-Chunks sind Metadatensätze, 
die sich in einer Broadcast WAV-Datei befinden. 

Einschränkungen

Die folgenden Einschränkungen betreffen die 
Handhabung importierter Metadaten aus tragbaren 
Rekordern.

• Die hier beschriebene BEXT-Spezifikation fügt 
einige Funktionen hinzu, die den von Avid-
Video-Editing-Anwendungen und Pro Tools 
benutzten Standards entsprechen – speziell 
Metadaten zur Beschreibung werden anders 
interpretiert.

• Wenn Sie mehrere Dateien importieren, in denen 
dieselben Metavariablen verschiedene Werte 
annehmen, importiert Pro Tools den Wert, 
der zuerst vorhanden ist gemäß folgender 
Reihenfolge:

• Mediendateien in einem Avid OMF-Container 
oder in einem MXF-Container

• alle iXML-Chunk-Metadaten in einem BWF

• alle BEXT-Chunk-Metadaten in einem BWF 

Begriffe für alle Produktions-
Workflows
Die folgenden Begriffe betreffen alle Produktions-
Workflows:

Timecode

Es gibt vier Arten von Timecodes, je nach 
Produktion:

Keycode – jedes einzelne Bild des Rohmaterials 
erhält bei der Herstellung eine eindeutige Timecode-
Position, die auch als Keycode bezeichnet wird.

SMPTE-Timecode – ist auch bekannt als LTC oder 
linearer Timecode. Die Zeit, die dieser Timecode 
wiedergibt, kann zum Beispiel die aktuelle 
Aufnahme-Uhrzeit sein oder so eingestellt werden, 
dass sie von einer bestimmten Startzeit des Tages 
aus fortschreitet.

Minuten:Sekunden – dieser Timecode basiert auf 
Minuten und Sekunden.

Ohne – kein Timecode. Die meisten digitalen 
Videorecorder für den Endverbraucher haben 
keine Möglichkeit, Timecode zu erzeugen.

Set-Tonmeister

Der Set-Tonmeister benutzt einen tragbaren 
Rekorder, um bei einer Filmaufnahme 
Mehrkanalton aufzuzeichnen, und gibt die so 
erstellten Rohmaterialdateien an ein oder mehrere 
andere Gewerke weiter:

• an Schnittassistenten zur Filmabtastung (nur bei 
Film-Workflows)

• an Avid-Videocutter

• Pro Tools-Bearbeiter/-in
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Begriffe nur für Film-Workflows
Die folgenden Begriffe beziehen sich nur auf Film-
Workflows:

die Shotliste

In einer Shotliste trägt der Kameraassistent jede 
gedrehte Szene mit ihrem Keycode ein. 
Der Schnittassistent braucht sie später, um im 
Filmabtaster Bild und Ton synchron anzulegen 
zu können.

Sound-Log

Beim Sound-Log handelt es sich um eine Liste, 
in der der Set-Tonmeister den Anfangs-Timecode 
jeder Szene und jedes Takes aufzeichnet. 

Kameraassistenz und Filmklappe

Der Kameraassistent betätigt und beschriftet die 
Filmklappe für jede Szene und jeden Take. 
Zu Beginn eines jeden Takes betätigt der 
Kameraassistent die Klappe, die folgende 
Informationen enthält:

• Szene, Take und Timecode – diese 
Informationen hält die Kamera bildlich fest.

• Das Geräusch der Klappe nimmt der tragbare 
Rekorder auf. Er sollte denselben Timecode 
verwenden, den die Filmklappe anzeigt.

Diese Informationen braucht der Schnittassistent, 
um Bild- und Tonmaterial synchron anzulegen für 
das Musterband.

Filmabtaster und Musterband

Der Filmabtaster (Telecine) ist ein Gerät, das das 
Filmmaterial und den Ton auf Video (auch Muster 
genannt) überspielt.

Das Video aus dem Filmabtaster enthält die 
Muster. Der SMPTE-Timecode auf dem 
Filmabtaster-Video ist ein anderer als der auf dem 
Rohmaterial vom Drehort.

FLEx-Datei

Die FLEx-Datei ist eine Textdatei, die während 
der Filmabtastung erzeugt wird und die zeigt, 
wie der Keycode des Filmmaterials, der Timecode 
des tragbaren Rekorders und der Timecode des 
Filmabtaster-Videos zueinander in Beziehung 
stehen. Bei der Batch-Digitalisierung des 
Filmabtaster-Videos in der Avid-Video-Editing-
Anwendung werden die Informationen aus der 
FLEx-Datei benutzt, um den Original-Timecode 
des Drehmaterials dem daraus erzeugten Audio- 
und Videorohmaterial zuzuweisen.

Unterstützte Dateiformate 
und Metadaten von tragbaren 
Rekordern
Pro Tools unterstützt die folgenden Audiodateien, 
die von tragbaren Rekordern aufgenommen 
werden:

• Mediendateien in einem OMF-Container

• MXF

• Broadcast WAV-Dateien mit den folgenden 
Metadaten:

• sowohl BEXT- als auch iXML-Chunks

• BEXT-Metadaten ohne iXML-Metadaten
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Anzeigen von Metadaten aus 
tragbaren Rekordern in 
Pro Tools
Die Anzeige der Metadaten aus tragbaren 
Rekordern kann innerhalb von Clips in der Timeline 
und der Clipliste aktiviert und deaktiviert werden.

So aktivieren und deaktivieren Sie die Anzeige der 
Metadaten aus tragbaren Rekordern in Playlists:

 Aktivieren bzw. deaktivieren Sie unter View > 

Clip eine der folgenden Optionen:

• Kanalname

• Szene und Take

So zeigen Sie Metadaten aus tragbaren Rekordern 
in der Clipliste an oder blenden sie aus:

1 Klicken Sie auf das Cliplisten-Popup-Menü, 
und wählen Sie „Show“.

2 Im Show-Untermenü aktivieren bzw. 
deaktivieren Sie folgende Optionen:

• Kanalname

• Szene und Take

Sobald sie in der Clipliste aktiviert sind, werden 
die Metadaten für Szene und Take jedem Clip 
hinzugefügt, sofern sie in der entsprechenden 
Audiodatei verfügbar sind.

Workspace-Unterstützung für 
Metadaten aus tragbaren 
Rekordern
Workspace-Browser zeigen die folgenden 
Metadaten für Mehrkanal-Aufnahmen an, die mit 
tragbaren Rekordern erstellt wurden:

• Dauer

• Dateikommentar (File Comment)

• Änderungsdatum (Date Modified)

• Erstellungsdatum (Date Created)

• Anz. Kanäle (# Channels)

• Format

• Sample Rate

• Bit Depth

• Originalzeitstempel

• Benutzerzeitstempel

• Band (Tape)

• TC-Rate (früher FPS)

• Kanalnamen (Channel Name)

• Szene (Scene)

• Take

• Drehdatum (Shoot Date)

• Tonrolle (Sound Roll)

• Tonrollen-TC

• Tonrollen-TC-Rate

• User Bits

• Band-ID (Tape ID)

• Projekt

• Circled

• Clip-Name

So zeigen Sie Metadaten aus tragbaren Rekordern 
im Workspace-Browser an oder blenden sie aus:

 Klicken Sie mit der rechten Maustaste auf den 
Spaltenkopf und aktivieren bzw. deaktivieren 
Sie einen der Typen von Rekorder-Metadaten.
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Band- und Tonrollen-Metadaten
Avid-Video-Editing-Anwendungen und tragbare 
Rekorder verwenden Band, um verschiedene 
Arten von Metadaten darzustellen: Avid 
verwendet Band, um den Namen des Filmabtaster-
Videos zu speichern, während eine BWF-Datei mit 
einem BEXT- oder iXML-Chunk Band 
verwendet, um den Namen des Tondatenträgers 
(sound roll) zu speichern.

Um diese Überschneidung zu verhindern, behält 
Pro Tools Band-Metadaten aus der Avid-Video-
Editing-Anwendung bei und behält die Tonrollen- 
und Band-Metadaten aus BWF-Audiodateien in 
ihren jeweiligen Metadaten-Feldern.

Aufnahmedatum-Metadaten
Viele tragbare Rekorder füllen das Shoot Date-Feld 
nicht aus sondern geben das Produktionsdatum 
anhand des Erstellungsdatums der Datei an. Wenn 
Pro Tools eine Datei aus einem tragbaren Rekorder 
importiert, wird überprüft, ob das Shoot Date-Feld 
Daten enthält. Ist es leer, kopiert Pro Tools das 
Erstellungsdatum der ursprünglichen Quelldatei 
in das Shoot Date-Feld der neuen, importierten 
Dateien.

Bearbeitung des Kanalnamens
Das Channel Name-Feld in Workspace enthält den 
Kanalnamen, gefolgt von der Kanalnummer in 
Klammern. Sie können den Kanalnamen für BWF-
Dateien bearbeiten. Beim Bearbeiten des 
Kanalnamens werden alle Eingaben in Klammern 
verworfen. Jedoch wird die Kanalnummer stets 
beibehalten.

Workflows mit tragbaren 
Rekordern
(Nur Pro Tools HD)

Um in Pro Tools Dateien mit Film-, Video- und 
Digitalvideomaterial aus tragbaren Rekordern 
zu bearbeiten, sind die folgenden Schritte 
erforderlich:

1 Bevor Sie Quelldateien übertragen, stellen Sie 
sicher, dass die Metadaten erhalten geblieben 
sind („Überprüfen der Metadaten aus den 
Quelldateien“ auf Seite 1238).

2 Übernehmen Sie die Quelldateien 
(„Übernehmen der Quelldateien“ auf 
Seite 1238).

3 Importieren Sie die Quelldateien in Pro Tools 
(„Importieren von Quelldateien in Pro Tools“ 
auf Seite 1239).

4 Ersetzen Sie Schnitte der Set-Tonmischung mit 
dem Ton verschiedener Takes derselben Szene 
(„Auswählen alternativer Rekorder-Kanäle zur 
Ersetzung eines Clips“ auf Seite 1242).
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Überprüfen der Metadaten 
aus den Quelldateien
Bevor Sie Quelldateien übernehmen, ist es 
wichtig, dass die Dateien in jeder Phase des 
Produktionsprozesses richtig vorbereitet wurden, 
sodass ihre ursprünglichen Metadaten erhalten 
geblieben sind.

Werden die ursprünglichen Metadaten nicht 
beibehalten, können Sie zusammengehörige 
Kanäle anhand anderer Daten (beispielsweise 
Dateierstellungsdatum oder Dateiname) 
identifizieren. Mit den ursprünglichen Metadaten 
ist die Zuordnung aber wesentlich einfacher.

Übernehmen der Quelldateien
Wenn Sie mit der Audionachbearbeitung von 
geschnittenen Videosequenzen beschäftigt sind, 
brauchen Sie die beiden folgenden Sätze von 
Quelldateien:

• AAF- oder OMF-Sequenzen mit geschnittener, 
an das Bild angelegter Set-Tonmischung 
(wie etwa referenzierte QuickTime-Movies 
oder Avid-Videos);

• Rohmaterial-Quelldateien, die die 
Mehrkanalaufnahme von einem tragbaren 
Rekorder beinhalten.

Diese Dateien erhalten Sie entweder getrennt 
(vom Avid-Video-Cutter und vom Set-Tonmeister) 
oder zusammen als Teil einer exportierten AAF- 
oder OMF-Sequenz, die Audio-Rohdateien 
(vom Avid Video-Cutter) enthält.

Getrennte Quelldateien
Wenn Sie eine AAF- oder OMF-Sequenz von 
einem Avid-Cutter erhalten und eine Audio-
Rohdatei von einem Set-Tonmeister, importieren 
Sie zuerst die Sequenz. Dann importieren Sie 
entweder die Audio-Rohdateien oder weisen 
Pro Tools an, in der Session das zugehörige Audio 
zu identifizieren. 

Sobald das Produktionsaudio importiert oder 
identifiziert wurde, können die Video- und 
Audioinhalte in Pro Tools abgeglichen werden.

Kombinierte Quelldateien
Es gibt zwei Methoden, mit denen der Avid-Cutter 
die Dateien vorbereiten kann, bevor er sie 
exportiert:

• Auto-Sync der Audio-Quelldateien in der Avid-
Bin und Platzierung in der Timeline

• Auto-Sync der Audio-Quelldateien sowie 
Verbleib in der Avid-Bin

Auto-Sync der Audio-Quelldateien in der Timeline 
mit der bearbeiteten Set-Tonmischung – bei 
den Audio-Quelldateien in der Avid-Bin wurde 
Auto-Sync durchgeführt, sodass sie jetzt an der 
bearbeiteten Tonmischung anliegen. Alle 
Audiokanäle befinden sich dabei in der Avid-
Timeline.

Wenn Sie diese Art von Sequenz in Pro Tools 
importieren, stehen das geschnittene Video, die 
bearbeitete Set-Tonmischung und alle Audio-
Quellmaterialien zum direkten Import in die 
Timeline zur Verfügung.

Siehe „Importieren von AAF- oder OMF-
Sequenzen in Pro Tools“ auf Seite 1239 und 
„Direkter Import Audio-Quelldateien in 
Pro Tools“ auf Seite 1240.
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Auto-Sync der Audio-Quelldateien sowie Verbleib 
in der Avid-Bin – das Audio-Quellmaterial vom 
Set wurde in einer Avid-Video-Editing-
Anwendung mit dem bearbeiteten Set-
Tonmischung synchronisiert. Die Audiokanäle 
sind jedoch nur in der Avid-Bin vorhanden. 

Importieren von Quelldateien 
in Pro Tools
Dieser Abschnitt beschreibt, wie Sie Audio-
Quelldateien der folgenden Typen importieren:

• AAF- oder OMF-Sequenzen

• Audio-Quelldateien (falls sie getrennt von der 
AAF- oder OMF-Sequenz entgegengenommen 
werden)

Importieren von AAF- oder OMF-
Sequenzen in Pro Tools

So öffnen Sie eine AAF- oder OMF-Sequenz als 
Pro Tools-Session:

1 Starten Sie Pro Tools.

2 Wählen Sie File > Open Session.

3 Navigieren Sie im Open Session-Dialogfeld zur 
AAF- oder OMF-Sequenz, die Sie importieren 
möchten.

4 Klicken Sie auf Open.

5 Benennen Sie ihre Session im File Name-Feld.

6 Wählen Sie im Audio File Type-Pop-Up-Menü 
die WAV-Option.

7 Wählen Sie die I/O-Einstellungen für diese 
Session. Ihr System wird mit mehreren 
vorkonfigurierten I/O-Einstellungen geliefert. 
Sie können aber auch eine eigene 
benutzerdefinierte I/O-Einstellung verwenden.

8 Klicken Sie auf Save.

Das Import Session Data-Dialogfeldfeld wird 
eingeblendet.

9 Wählen Sie im Audio Media Options-Pop-Up-
Menü die Link to Source Media (Where 
Possible)-Option.

10 Wählen Sie im Video Media Options-Pop-Up-
Menü die Link to Source Media-Option.

11 Wählen Sie im Source Tracks-Abschnitt die 
gewünschten Spuren aus. Klicken Sie dazu auf 
das Popup-Menü rechts neben dem Spurnamen 
und wählen Sie „Import As New Track“. 

12 Ändern Sie andere Parameter.

13 Klicken Sie auf OK.

In diesem Fall enthält die AAF- bzw. OMF-
Sequenz beim Import in Pro Tools kein 
Audio-Quellmaterial bzw. keinen Verweis 
auf dieses. Der Avid-Cutter muss die Set-
Dateien dem Pro Tools-Benutzer separat 
übermitteln. Der Avid-Cutter kann entweder 
die Audiodateien aus dem Avid- oder dem 
OMFI Media Files-Ordner übermitteln oder 
die Audio-Quelldateien, die nicht in Media 
Composer bearbeitet wurden.

Pro Tools erlaubt das Öffnen und Importieren 
der OMF- oder AAF-Sequenzen, die auf 
Audiodateien mit gemischten Samplerates 
oder Bitraten verweisen. Audiodateien werden 
in die höchste Samplerate der importierten 
Dateien (bei neuen Sessions) oder die aktuelle 
Samplerate (bei vorhandenen Sessions) 
konvertiert. Dateien mit gemischten Bitraten, 
die bereits über die Ziel-Samplerate verfügen, 
werden ohne Konvertierung importiert.

Um mehrere Spuren auszuwählen, klicken Sie 
bei gedrückter Wahltaste (Mac) bzw. Alt-Taste 
(Windows) auf die Popup-Menüs der 
gewünschten Spuren und wählen „Import As 
New Track“.
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Pro Tools erstellt einen neuen Audio Files-, einen 
Video Files-Ordner sowie eine cache.wfm- und 
eine Session-Datei an den festgelegten Orten. 
Diese Session stimmt mit dem Audiodateityp, der 
Samplerate und der Bitrate des Audiomaterials im 
ausgewählten OMF- oder AAF-Material überein. 
Im Source Tracks-Abschnitt des Import Session 
Data-Dialogfelds ausgewählte Spuren werden 
automatisch in der Timeline platziert. 

Direkter Import Audio-
Quelldateien in Pro Tools
Falls die AAF- oder OMF-Sequenz, die Sie in 
Pro Tools importiert haben, keine Audio-
Quelldateien enthielt, können Sie sie separat in die 
Session importieren. Hierzu verwenden Sie die 
Mediendateien, die der Set-Tonmeister 
bereitgestellt hat. 

Sie können sowohl monofone als auch polyfone 
Audiodateien aus tragbaren Rekordern in 
Pro Tools importieren, indem Sie eine der 
folgenden Methoden verwenden:

• Wählen Sie File > Import > Audio und 
anschließend die zu importierenden Dateien.

• Ziehen Sie die Dateien aus dem Workspace-
Browser oder vom Desktop.

Reparatur falsch angelegter 
Audiodateien beim Import, wenn 
nicht aus Avid exportiert wurde
Wenn Sie Pro Tools benutzen, um Audio-
Quelldateien zu importieren, die nicht aus einer 
Avid-Video-Editing-Anwendung exportiert 
wurden – wie etwa Audiodateien, die getrennt von 
einer AAF- oder OMF-Sequenz bereitgestellt 
wurden – kann dieses Audiomaterial gegenüber 
der AAF- oder OMF-Sequenz um bis zu einem 
halben Bild versetzt sein.

Dieses Fehlanlegen beruht auf der Inkompatibilität 
der framegenauen Zeitstempelung in Avid-Video-
Editing-Anwendungen mit der samplegenauen 
Zeitstempelung in Pro Tools. Beim Versuch, beide 
zu verbinden, wird der Ton falsch angelegt.

Um diese Diskrepanz zu beheben, müssen Sie 
die Audio-Quelldateien gegebenenfalls nach 
dem Import in Pro Tools manuell angleichen. 
Sie können die Audio-Quelldateien auch mit 
einem Hilfsprogramm wie SynchroArts 
Titan angleichen.

Weitere Informationen zum Import von 
AAF- und OMF-Sequenzen in Pro Tools 
finden Sie unter „Importieren von AAF- 
und OMF-Sequenzen“ auf Seite 355.

In Projekten mit großen Mengen an 
Audiomaterial kann es unpraktisch sein, 
dieses als Referenz in Pro Tools zu 
importieren. Sie können Pro Tools für die 
Suche passenden Audiomaterials außerhalb 
der Session konfigurieren, wenn es nach 
übereinstimmenden Dateien aus tragbaren 
Rekordern sucht. Weitere Informationen 
finden Sie unter „Select Areas to Search“ auf 
Seite 1246.
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Do Not Convert Sample Rate on 
Import (Voreinstellung)
In manchen Workflows ist es üblich, dass 
Audiomaterial für die Produktion bei 48,048 Hz 
aufgenommen wird, um für ein Pull-Down auf 
48 kHz später im Workflow vorzusorgen. Beim 
Import von Audio mit dieser speziellen Samplerate 
kann Pro Tools entweder die Samplerate der Datei 
in 48 kHz konvertieren oder während der 
Wiedergabe in Echtzeit ein Pull-Down auf 48 kHz 
durchführen.

Wenn Sie das Audiomaterial mit 48,048 kHz 
importieren möchten und Pro Tools das Pull-
Down auf 48 kHz in Echtzeit durchführen soll, 
gehen Sie wie folgt vor:

So legen Sie die Voreinstellung „Do Not Convert 
Sample Rate on Import“ fest:

1 Wählen Sie File > Preferences.

2 Klicken Sie auf die Processing-Registerkarte.

3 Im Import-Abschnitt finden Sie die 
Voreinstellung Don't Convert Sample Rates 

on Import.

4 Aktivieren Sie diese Voreinstellung, um das 
Echtzeit-Pull-Down der Audiodateien auf 
48,048 kHz zu ermöglichen.

Festlegen von Spuren für 
tragbare Rekorder
Das Arbeiten mit Daten aus tragbaren Rekordern 
erfordert häufig, dass mit Pro Tools zusätzliche 
administrative Aufgaben ausgeführt werden, um 
die Kanäle mit Produktions- und Metadaten zu 
identifizieren. Diese Dateiprozesse können Ihr 
System stark beanspruchen, wenn große 
Datenmengen zu verarbeiten sind. 

Pro Tools erlaubt Ihnen das Kennzeichnen von 
Spuren aus tragbaren Rekordern nach dem Import. 
Damit wird sichergestellt, dass das Programm die 
spezifischen Prozesse für Daten aus tragbaren 
Rekordern ausschließlich für Kanäle durchführt, 
die die entsprechenden Daten enthalten.

So kennzeichnen Sie eine Spur aus einem 
tragbaren Rekorder:

1 Rechtsklicken Sie auf den Namen einer Spur, 
die Sie als Spur aus einem tragbaren Rekorder 
kennzeichnen möchten.

2 Klicken Sie auf Field Recorder Guide Track.

3 Wiederholen Sie diesen Vorgang für jede 
betroffene Spur in der Session.

Um mehrere Spuren zu kennzeichnen, wählen 
Sie die Spuren aus und rechtsklicken Sie auf 
den Namen einer der ausgewählten Dateien.

Jede Monospur aus einem tragbaren 
Rekorder muss gekennzeichnet werden, 
damit die Spezialfunktionen von Pro Tools 
auf die Spur angewendet werden können.

Um die Kennzeichnung von einer Spur zu 
entfernen, rechtsklicken Sie auf ihren Namen 
und heben Sie die Aktivierung der Field 
Recorder Guide Track-Option auf. 
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Anzeigen von Mehrkanal-
Dateien aus einem tragbaren 
Rekorder in der Clipliste
Beim Import von Mehrkanal-Aufnahmen aus 
einem tragbaren Rekorder speichert Pro Tools das 
Mehrkanal-Audio als Interleaved-Audiodateien, 
die in der Clipliste als ein Element angezeigt 
werden. 

In früheren Versionen von Pro Tools wurden 
Mehrkanaldateien als separate Dateien 
gespeichert, eine pro Kanal. Pro Tools behandelt 
diese Gruppen zusammengehöriger Clips als 
einzelne Elemente. Eine Schaltfläche zum 
Erweitern/Reduzieren neben einem Element in der 
Clipliste zeigt einen gruppierten Mehrkanal-Clip 
an. Wenn Sie mit Material arbeiten, das aus einer 
früheren Version von Pro Tools importiert wurde, 
sehen Sie diese Sammelclips eventuell.

Damit Mehrkanal-Audioclips, die von tragbaren 
Rekordern importiert werden, als Sammelclip 
angezeigt werden, müssen beide Teilclips über 
folgende Eigenschaften verfügen:

• Gleiche Länge

• Gleiches Clipnamen-Präfix (wie Audio File oder 
Audio File_01)

• Fortlaufend nummerierte Clipnamen-Suffixe, 
von A1 bis A8

Beispielsweise würden die Clips Audio File_01.A1 
und Audio File_01.A2 in der Clipliste in einem 
Mehrkanal-Clip gruppiert werden.

Wurde ein bereits bestehender Stereo- oder 
Mehrkanal-Sammelclip auf mehrere Monospuren 
gezogen und so editiert, dass mehrere einzelne 
Clips nicht mehr gleich lang sind, wird die 
Stereoanzeige entfernt und die Clips werden in der 
Clipliste einzeln angezeigt. 

Auswählen alternativer 
Rekorder-Kanäle zur 
Ersetzung eines Clips
(Nur Pro Tools HD)

Sobald Sie eine AAF- oder OMF-Sequenz in die 
Timeline importiert haben, können Sie die 
ursprüngliche Set-Tonmischung durch einen 
entsprechenden Alternativkanal aus einem 
tragbaren Rekorder ersetzen und dabei die 
ursprünglichen Schnitte bewahren.

Falls durch den Import Session Data-Vorgang 
bereits alle Audio-Quelldateien direkt in die 
Timeline importiert wurden, ist dieser 
Vorgang nicht nötig.
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Ersetzen eines Clips durch ein 
passendes Segment aus einem 
alternativen Kanal aus einem 
tragbaren Rekorder
Sie können einen Monoclip (oder einen 
selektierten Abschnitt aus einem Monoclip) durch 
ein passendes Segment aus einem alternativen 
Kanal aus einem tragbaren Rekorder, der 
gleichzeitig aufgenommen wurde, ersetzen. Alle 
Fades, die auf dem ursprünglichen Clip bereits 
vorgenommen wurden, werden automatisch auf 
den Ersatzclip angewendet und alle bereits 
vorhandenen Automatisierungen auf der Spur 
bleiben erhalten.

Ersetzen eines Clips durch einen passenden 
alternativen Kanal aus einem tragbaren Rekorder:

1 Treffen Sie in der Timeline eine Selektion, 
die den Clip oder den Teil eines Clips, den Sie 
ersetzen wollen, enthält oder größer als 
dieser ist.

2 Sie haben folgende Möglichkeiten:

• Führen Sie mit einem beliebigen Edit-Tool einen 
Rechtsklick auf den zu ersetzenden Clip aus und 
wählen Sie aus dem Pop-Up-Menü die Matching 
Field Recorder Channels-Option.

• Klicken Sie mit dem Selector-Tool bei 
gedrückter Befehl- und Wahltaste (Mac) bzw. 
Strg- und Alt-Taste (Windows) auf die 
Selektion, die Sie ersetzen möchten.

3 Wählen Sie aus dem Matching Field Recorder 

Channels-Pop-Up-Menü den alternativen Clip 
aus, durch den Sie den ursprünglichen Clip 
ersetzen möchten. 

4 Wiederholen Sie diesen Vorgang für jeden Clip, 
den Sie ersetzen möchten, und auf jeder Spur.

Diese Funktion ist besonders nützlich, wenn 
Sie sie in Kombination mit dem Duplizieren 
der Set-Tonmischungs-Spur verwenden. 
Beispielsweise können Sie so den Ton von 
einem Angel- bzw. Boom-Mikrofon durch den 
Ton von einem Ansteckmikrofon ersetzen – 
und dabei alle Schnitte und Blenden der 
ursprünglichen Set-Tonmischung in der 
AAF- oder OMF-Sequenz beibehalten. 

Um durch die Liste der vorhandenen 
Alternativen für die Selektion zu navigieren, 
benutzen Sie bei gedrückter Befehls- und 
Wahltaste (Mac) bzw. Strg- und Alt-Taste 
(Windows) die Pfeiltasten.

Wenn Sie zum ersten Mal das Matching Field 
Recorder Channels-Menü eines bestimmten 
Clips öffnen, muss Pro Tools alternative 
Kanäle suchen. Während dieses Vorgangs 
wird die Meldung „Searching for metadata in 
the background“ angezeigt. Sobald die Suche 
abgeschlossen ist, schließen Sie das Menü 
und öffnen Sie es erneut, um die gefundenen 
Alternativen anzuzeigen.

Wenn der Set-Tonmeister beim Filmdreh 
den Kanalnamen (oder eine andere 
Beschreibung) eingegeben hat, zeigt das 
Matching Field Recorder Channels-Pop-
Up-Menü diese Information an.
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Bedingungen für alternative 
Kanäle aus tragbaren 
Rekordern
Ein alternativer Kanal ist standardmäßig als Ersatz 
für den ursprünglichen Kanal verfügbar 
(dargestellt durch den Clip oder einen Teil des 
Clips in der Timeline-Selektion), wenn die 
folgenden Bedingungen zutreffen:

• beide Kanäle gehören zum Mehrkanal-Teil einer 
Aufnahme, die gleichzeitig auf einem oder 
mehreren tragbaren Rekordern erstellt wurde;

• beide Kanäle überlappen sich mindestens einmal 
zwischen ihrem Start- und End-Timecode;

• die im Match Criteria-Dialogfeld eingestellten 
Kriterien sind erfüllt;

• die beim Drehen eingebetteten Metadaten 
wurden vor dem Import in Pro Tools gesichert.

Unterschiedliche tragbare Rekorder können 
jedoch unterschiedliches Verhalten aufweisen und 
in manchen Fällen können die vorhandenen 
Metadaten falsch oder unvollständig sein oder 
fehlen. Um in solchen Situationen das 
Identifizieren alternativer Kanäle aus tragbaren 
Rekordern zu erleichtern, können Sie in Pro Tools 
die Kriterien für alternative Kanäle einstellen.

Field Recorder Channels Match Criteria

Im „Field Recorder Channels Match Criteria“-
Dialogfeld können Sie die Kriterien, die Pro Tools 
zur Identifizierung alternativer Kanäle aus 
tragbaren Rekordern anwendet, konfigurieren und 
damit flexibel auf Ihre Gegebenheiten reagieren. 

Passende Alternativen können anhand der 
folgenden Kriterien gesucht werden:

File Creation Date – das vom Betriebssystem 
vergebene Dateierstellungsdatum.

Shoot Date – das in den iXML-Metadaten 
angegebene Drehdatum.

Szene (Scene)  – die in den iXML-Metadaten 
angegebene Szenennummer.

Informationen zur korrekten Bewahrung der 
Metadaten in Ihren Quelldateien finden Sie 
unter „Überprüfen der Metadaten aus den 
Quelldateien“ auf Seite 1238.

Field Recorder Channels Match Criteria-Fenster
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Szene und Take – die in den iXML-Metadaten 
angegebene Szenen- und Take-Nummer.

Tape Name – der in den iXML-Metadaten 
angegebene Bandname; muss mit dem Bandnamen 
der Führungsspur-Datei übereinstimmen.

Sound Roll Name – der in den iXML-Metadaten 
angegebene Tonrollenname; muss mit dem 
Tonrollennamen der Führungsspur-Datei 
übereinstimmen.

Sound Roll Name to Tape Name – der in den 
iXML-Metadaten angegebene Bandname muss 
mit dem Tonrollennamen der Führungsspur-Datei 
übereinstimmen.

Tape Name to Sound Roll Name – der in den 
iXML-Metadaten angegebene Tonrollenname 
muss mit dem Bandnamen der Führungsspur-Datei 
übereinstimmen.

First X Characters in File Name – sucht passende 
Alternativen auf Basis einer durch den Benutzer 
festgelegen Anzahl an Zeichen im Dateinamen, 
beginnend am Anfang des Namens.

Kanalname – der in den iXML-Metadaten 
angegebene Kanalname.

Channel Number – die in den iXML-Metadaten 
angegebene Kanalnummer.

Name and Sort Tracks By

Mit dieser Option legen Sie die Methode fest, nach 
der Pro Tools Audiodateien benennt und sortiert, 
die durch die Erweiterung alternativer Kanäle aus 
einem tragbaren Rekorder erstellt wurden. 

So legen Sie die Kriterien für Alternativen fest:

1 Sie haben folgende Möglichkeiten:

• Klicken Sie im Edit-Fenster mit der rechten 
Maustaste auf einen Monoclip und wählen Sie 
aus dem Popup-Menü Matching Field Recorder 

Channels > Match Criteria.

• Klicken Sie im Edit-Fenster bei gedrückter 
Befehls- und Wahltaste (Mac) bzw. Strg- und 
Alt-Taste (Windows) auf einen Monoclip und 
wählen Sie aus dem Popup-Menü Field 

Recorder Channel Match Criteria.

• Klicken Sie mit der rechten Maustaste auf das 
Namensfeld der Spur, für die Sie eine Alternative 
finden möchten, und wählen Sie aus dem Popup-
Menü Field Recorder Channel Match Criteria.

2 Wählen Sie im „Field Recorder Channels 
Match Criteria“-Fenster die Kriterien für 
Alternativen aus, die Pro Tools bei der Suche 
berücksichtigen soll.

3 Wählen Sie aus dem „Match Timecode Plus 
Popup“-Menü ANY oder ALL. Wählen Sie 
ANY, wenn Sie Alternativen für alle 
festgelegten Kriterien finden möchten. Bei der 
Auswahl von ALL müssen alle festgelegten 
Kriterien erfüllt sein, damit Pro Tools eine 
Alternative anzeigt.

4 Bei zukünftigen Suchen nach alternativen 
Kanälen aus tragbaren Rekordern berücksichtigt 
Pro Tools die von Ihnen festgelegten Kriterien so 
lange, bis Sie sie ändern.

Nach Take passende Alternativen für Kanäle 
müssen auch nach Szenen übereinstimmen.

Wenn die oben angegebenen Kriterien erfüllt 
sind, akzeptiert Pro Tools übereinstimmende 
Timecodes bei „Original Time Stamp“ und 
„Sound Roll Timecode“.

Wenn Sie möglichst viele Alternativen 
finden möchten, sollten Sie ANY wählen. 
Danach können Sie mit ALL die 
Suchergebnisse auf ein bestimmtes 
Aufnahmedatum, einen Kanalnamen oder 
ein anderes Kriterium eingrenzen

Mittels Reset-Schaltfläche werden alle 
Kriterien auf ihre Standardwerte 
zurückgesetzt.
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Select Areas to Search

Standardmäßig sucht Pro Tools im Audio Files-
Ordner der aktuellen Session nach alternativen 
Dateien aus einem tragbaren Rekorder. Da in 
diesen Geräten oft große Mengen an Audiodaten 
gespeichert sind, kann der Import der benötigten 
Dateien in eine Pro Tools-Session eine komplexer, 
langwieriger Vorgang sein.

Über die Select Areas to Search-Option können 
Sie zusätzliche Speicherorte (Ordner oder 
Festplatten) für die Alternativen-Suche angeben

So wählen Sie Suchbereiche für Alternativspuren 
aus tragbaren Rekordern:

1 Rechtsklicken Sie auf den Namen einer Spur 
aus einem tragbaren Rekorder.

2 Kicken Sie auf Select Areas to Search. 

3 Navigieren Sie zu dem Ordner oder der 
Festplatte, die Pro Tools nach Alternativen 
durchsuchen soll.

4 Klicken Sie auf Choose, um Ihre Wahl zu 
bestätigen.

5 Falls Sie einen Suchbereich aus der Liste 
löschen möchten, tun Sie dies über die Minus-
Schaltfläche (-).

6 Sie haben folgende Möglichkeiten:

• Klicken Sie auf Save, um das Select Areas to 
Search-Dialogfeld zu schließen und die neuen 
Suchbereich-Einstellungen zu speichern.

• Klicken Sie auf Save & Index, um die neuen 
Suchbereich-Einstellungen zu speichern und die 
Ordner neu zu indizieren. Weitere 
Informationen finden Sie unter „Erneutes 
Indizieren“ auf Seite 1246.

Erneutes Indizieren

Wenn einem der festgelegten Suchbereiche neue 
Audiodateien hinzugefügt werden, muss Pro Tools 
den Index der Inhalte des entsprechenden Ordners 
aktualisieren, damit Sie auf die neuen 
Audiodateien zugreifen können. 

So indizieren Sie alle Alternativen-Suchbereiche 
neu:

1 Klicken Sie im Field Recorder Channels Match-
Dialogfeld auf Select Areas to Search.

2 Klicken Sie auf Save & Index, um die aktuellen 
Einstellungen zu speichern und die in der Liste 
aufgeführten Suchbereiche neu zu indizieren.

Klicken Sie bei gedrückter Wahltaste (Mac) 
oder Alt-Taste (Windows) auf ein beliebiges 
Element, um alle Kriterien im Dialogfenster 
auszuwählen oder die Auswahl aufzuheben.

Select Areas to Search-Dialogfeld

Pro Tools zeigt eine Fehlermeldung an, falls 
Sie einen Unterordner ausgewählt haben 
dessen übergeordneter Ordner bereits in der 
Suchbereichliste enthalten ist.
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Fehlende Suchordner

In den Suchbereichen enthaltene Ordner können 
aus verschiedenen Gründen fehlen (beispielsweise 
durch Löschen oder fehlender Festplatte) Falls ein 
Ordner fehlt, zeigt Pro Tools beim Öffnen des 
Select Areas to Search-Dialogfelds eine 
Fehlermeldung an. Der Dateipfad des fehlenden 
Ordners wird in kursiver grauer Schrift angezeigt.

Erweiterung alternativer 
Audiokanäle aus einem 
transportablen Rekorder auf 
neue Spuren
(Nur Pro Tools HD)

Wenn Sie mit einem Monoclip arbeiten, der Teil 
einer Mehrkanal-Aufnahme ist, können Sie diesen 
Clip (oder einen selektierten Teil davon) auf neue 
Spuren erweitern. Die neuen Spuren spiegeln die 
alternativen Kanäle wider und behalten 
gleichzeitig sämtliche Schnitte oder Blenden bei. 

Mithilfe dieser Funktion können Sie 
beispielsweise auf einfache Weise verschiedene 
Versionen einer bearbeiteten Dialogspur erstellen, 
die dem Eingangsmaterial aus mehreren Kanälen 
(Mikrofonen) entsprechen, die zur gleichen Zeit 
aufgenommen wurden.

So erweitern Sie alternative Kanäle aus einem 
tragbaren Rekorder auf neue Spuren:

1 Führen Sie in der Timeline einen der folgenden 
Schritte aus:

• Um einen einzelnen Clip auf einer einzelnen 
Spur zu erweitern, rechtsklicken Sie auf 
den Clip.

• Um einen Ausschnitt des Clips auf die Spur zu 
erweitern, nehmen Sie eine Selektion vor, die 
eine beliebige Anzahl von (auch überlappenden) 
Clips auf einer Spur beinhaltet, und klicken Sie 
bei gedrückter Befehls- und Wahltaste (Mac) 
bzw. Strg- und Alt-Taste (Windows) auf die 
Selektion.

• Um alle Clips auf eine Monospur zu erweitern, 
rechtsklicken Sie auf das Namensfeld der Spur. 

2 Klicken Sie auf das Expand Channels to New 
Tracks-Untermenü und wählen Sie eine der 
folgenden Methoden zum Erweitern alternativer 
Kanäle für die Auswahl auf neue Spuren:

• By Match Criteria

• By Time Code Only

Über eine Suche außerhalb der Session 
importierte Dateien aus tragbaren 
Rekordern werden stets im WAV-Format 
importiert, falls sie konvertiert werden 
müssen. Dadurch bleiben die Metadaten 
aus dem tragbaren Rekorder erhalten. Ein 
im Session Setup-Fenster ausgewählter 
Session-Dateityp wird ignoriert.

Übereinstimmende alternative Kanäle aus 
einem tragbaren Rekorder sind Monokanäle, 
die üblicherweise gleichzeitig mit dem 
ursprünglichen Clip aufgenommen wurden 
(wie etwa bei Mehrkanal-Aufnahmen, die mit 
einem oder mehreren tragbaren Rekordern 
erstellt wurden). Weitere Informationen zur 
genauen Einstellung der Kriterien für 
alternative Kanäle finden Sie unter 
„Bedingungen für alternative Kanäle aus 
tragbaren Rekordern“ auf Seite 1244.

Der Kanal, den Sie erweitern möchten, muss 
ein Monokanal sein.

Wenn Sie nur einen Clipabschnitt einer Spur 
erweitern, ist die „By Match Criteria“-
Option nicht verfügbar, falls entweder keine 
gültigen Alternativen gefunden werden oder 
falls im „Field Recorder Channels Match 
Criteria“-Dialogfeld die ANY-Option 
ausgewählt ist und keine Kriterien 
ausgewählt sind.
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Wenn alternative Kanäle aus einem tragbaren 
Rekorder verfügbar sind, erweitert Pro Tools sie 
(sowie den Kanal der ursprünglichen Spur) 
entsprechend der ausgewählten Parameter auf 
neue Spuren.

Bestimmen der Methode zur 
Erweiterung alternativer 
Kanäle aus einem 
transportablen Rekorder auf 
neue Spuren
Alternative Kanäle aus einem tragbaren Rekorder 
können auf neue Spuren erweitert werden. Dies 
geschieht auf Basis der im Field Recorder 
Channels Match Criteria-Dialogfeld festgelegten 
Kriterien (weitere Informationen unter „Field 
Recorder Channels Match Criteria“ auf 
Seite 1244) oder nur nach Timecode.

Expanding Matching Field 
Recorder Channels by Match 
Criteria
Bei Auswahl von Expand Channels to New 

Tracks > By Match Criteria wird für jeden 
gefundenen einzelnen alternativen Kanal, der den 
festgelegten Suchkriterien entspricht, eine neue 
Spur erstellt.

Wenn Kanäle mit zwei 
Übereinstimmungskriterien (beispielsweise 
Kanalname und Kanalnummer) gefunden werden, 
wird eine weitere Spuren für jeden dieser Kanäle 
angelegt. Jeder neue Erweiterungskanal behält den 
Namen des ursprünglichen Kanals und am 
Namensende wird ein Punkt und eine fortlaufende 
Identifizierungsnummer angehängt. An den ersten 
alternativen Kanal wird „.2“, an den zweiten „.3“ 
angehängt, und so weiter.

Jede neue Spur enthält nur Kanäle, die den für 
Alternativen festgelegten Kriterien entsprechen, 
und behält die Schnitte und Blenden der 
ursprünglichen Selektion bei. Lücken spiegeln 
Clips der ursprünglichen Auswahl wider, für die es 
keine passenden alternativen Kanäle mit diesem 
Kanalnamen gab.

Weitere Informationen über die Optionen zur 
Erweiterung auf neue Spuren finden Sie unter 
„Bestimmen der Methode zur Erweiterung 
alternativer Kanäle aus einem 
transportablen Rekorder auf neue Spuren“ 
auf Seite 1248.

Ergebnis der Erweiterung einer Selektion auf neue 
Spuren
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Benennung und Sortierung erweiterter 
Kanäle

Damit Sie von größtmöglicher Flexibilität 
profitieren, können Sie in Pro Tools die 
Benennung und Sortierung der Kanäle, die mit 
Hilfe des „Expand Channels to New Tracks by 
Match Criteria“-Befehls erstellt wurden, steuern.

Dieser Parameter wird im Field Recorder 
Channels Match Criteria-Dialogfeld eingestellt 
(weitere Informationen siehe „Field Recorder 
Channels Match Criteria“ auf Seite 1244.)

Benennung von Spuren bei der Erweiterung 
alternativer Kanäle aus tragbaren Rekordern 
nach Kanalnamen

Spuren, die auf diese Weise erweitert werden, 
werden folgendermaßen benannt:

• Bei Kanälen mit eindeutigen Kanalnamen, aus 
denen nur eine neue Spur hervorgeht, wird jede 
Spur unter Verwendung des Namens der 
Originalspur plus des Kanalnamens benannt. 
Beispielsweise würde so der eindeutige 
Kanalname Boom der Spur Guide.A1 eine neue 
Spur namens Guide.A1.Boom erzeugen.

• Bei eindeutigen Kanalnamen, aus denen zwei 
oder mehr Spuren hervorgegangen sind, haben 
diese neuen Spuren denselben Kanalnamen und 
es wird mit einem Punkt eine fortlaufende 
Nummer angehängt. An den ersten alternativen 
Kanal wird „.2“, an den zweiten „.3“ angehängt, 
und so weiter. Beispielsweise würde so der 
eindeutige Kanalname Boom der Spur Guide.A1 
neue Spuren namens Guide.A1.2 und 
Guide.A1.3 erzeugen.

Benennung von Spuren bei der Erweiterung 
alternativer Kanäle aus tragbaren Rekordern 
nach Kanalnummer

Spuren, die auf diese Weise erweitert werden, 
werden folgendermaßen benannt:

• Bei Kanälen mit eindeutigen Kanalnummern, 
aus denen nur eine Spur hervorgeht, wird jede 
Spur unter Verwendung des Namens der 
Originalspur plus der Kanalnummer benannt. 
Beispielsweise würde so die eindeutige 
Kanalnummer A1 aus der Spur Guide.A1 eine 
neue Spur namens Guide.A1.A1 erzeugen.

• Bei eindeutigen Kanalnummern, aus denen zwei 
oder mehr Spuren hervorgegangen sind, haben 
diese neuen Spuren dieselben Kanalnummern 
und es wird mit einem Punkt eine fortlaufende 
Nummer angehängt. An den ersten alternativen 
Kanal wird „.2“, an den zweiten „.3“ angehängt, 
und so weiter. Beispielsweise würde so die 
eindeutige Kanalnummer A1 aus der Spur 
Guide.A1 neue Spuren namens Guide.A1.A1.2 
und Guide.A1.A1.3 erzeugen.

Benennung von Spuren bei der Erweiterung 
alternativer Kanäle nach Kanalname und -
nummer

Spuren, die auf diese Weise erweitert werden, 
werden folgendermaßen benannt:

• Bei eindeutigen Kombinationen aus Kanalname 
und -nummer, aus denen nur eine Spur 
hervorgeht, wird jede Spur unter Verwendung 
des Namens der Originalspur plus des 
Kanalnamens und der Kanalnummer benannt. 
Beispielsweise würde so die eindeutige 
Kombination aus Kanalname und -nummer 
Boom.A1 aus der Spur Guide.A1 eine neue Spur 
namens Guide.A1.Boom.A1 erzeugen.
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• Bei eindeutigen Kombinationen aus Kanalname 
und -nummer, aus denen zwei oder mehr Spuren 
hervorgehen, haben diese neuen Spuren 
dieselben Kanalnummern und es wird mit einem 
Punkt eine fortlaufende Nummer angehängt. An 
den ersten alternativen Kanal wird „.2“, an den 
zweiten „.3“ angehängt, und so weiter. 
Beispielsweise würde so dem eindeutigen 
Kanalnamen Boom.A1 aus der Spur Guide.A1 
neue Spuren namens Guide.A1.A1.2 und 
Guide.A1.A1.3 erzeugen.

Erweiterung alternativer 
Audiokanäle aus einem 
transportablen Rekorder nur 
nach Timecode
Mit dem Expand Channels To New Tracks By 

Timecode Only-Befehl können Sie eine komplette 
Spur oder nur ausgewählte Clips auf neue Playlists 
in derselben Spur oder auf neue Spuren erweitern. 
Auf diese Weise werden alle anderen Clips, 
die an derselben Position im Timecode 
aufgenommen wurden, unabhängig von 
Kanalname oder -nummer angezeigt. Dies ist 
besonders dann hilfreich, wenn Sie bearbeitete 
Führungsspuren der ursprünglichen Audioquelle 
erweitern möchten, die mit Verweis auf den 
Timecode aufgenommen wurden, bei denen aber 
keine Kanalnamen oder -nummern in den 
Audiodateien vermerkt sind. 

Bei der Suche nach Alternativen nur nach 
Timecode zieht Pro Tools sowohl den 
Originalzeitstempel als auch den Tonrollen-
Timecode heran. Wenn eine Übereinstimmung 
zwischen Band- und Tonrollennamen (oder 
umgekehrt) gefunden wird, sucht Pro Tools auch 
Übereinstimmungen zwischen 
Originalzeitstempel und Tonrollen-Timecode.

Beispiel-Workflow: Arbeiten mit 
einer Führungsspur
Bei Live-Konzertvideos erfolgt die 
Videoaufnahme separat, während der Ton mit 
Pro Tools aufgenommen wird. Der Video-Cutter 
verwendet eine Audiospur, die mit dem Bild in der 
Videobearbeitungs-Software (etwa Avid Media 
Composer) bearbeitet wird, als Vorgabe für das 
Bild. Die bearbeitete Führungsspur wird dann an 
Pro Tools zurückgeschickt, muss allerdings zum 
Mischen und Mastern auf die angeglichenen 
Originalspuren erweitert werden.

1 Mehrspurige Audioinhalte werden in Pro Tools 
bei laufendem Timecode aufgenommen. 
Gleichzeitig wird eine Mono- oder 
Stereomischung als Führungsspur für den 
Video-Cutter aufgenommen.

2 Die Bild- und Audio-Führungsspuren werden in 
einer Video-Editing-Anwendung (wie etwa 
Avid Media Composer) bearbeitet. 

3 Die bearbeiteten Audio-Führungsspuren werden 
vom Video-Cutter als AAF-(oder OMF-) 
Sequenzen exportiert und beinhalten Überhänge 
von mindestens 2 Bildern. 

4 Die AAF-(oder OMF-)Sequenz wird als neue 
Session in Pro Tools importiert.

5 Die ursprünglichen Audiodateien und die 
unbearbeitete Führungsspur werden ebenfalls 
in die Session importiert.

6 Die unbearbeitete ursprüngliche Führungsspur 
wird wieder mit der Session gekoppelt (siehe 
„Neukoppeln der ursprünglichen, nicht 
bearbeiteten Führungsspur“ auf Seite 1251).
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7 Klicken Sie in Pro Tools mit der rechten 
Maustaste auf die Führungsspur und wählen Sie 
Expand Channels to New Tracks > By 

Timecode Only. Die ursprünglichen 
Ausgangsspuren werden auf neue Spuren mit 
Bearbeitungen und Fades, die der Führungsspur 
entsprechen, erweitert.

Neukoppeln der ursprünglichen, nicht 
bearbeiteten Führungsspur

Nach dem Importieren der AAF-(oder OMF-) 
Sequenz und der ursprünglichen Audio-
Quelldateien in die Session wird empfohlen, die 
bearbeitete Führungsspur neu mit den 
ursprünglichen, nicht bearbeiteten Quell-
Audiodaten zu koppeln.

So koppeln Sie die ursprüngliche, nicht 
bearbeitete Führungsspur neu:

1 Öffnen Sie einen Workspace-Browser. Wählen 
Sie Ihre Session in der Locations-Spalte und 
öffnen oder erweitern Sie den Audio Files-
Ordner der Session.

2 Klicken Sie mit der rechten Maustaste im 
Browser auf die Audiodatei mit der bearbeiteten 
Führungsspur und wählen Sie Relink Selected 

Items.

3 Suchen Sie im oberen Bereich des Relink-
Fensters die Audiodatei mit der ursprünglichen, 
nicht bearbeiteten Führungsspur, die in 
Pro Tools aufgenommen wurde. 

4 Wählen Sie im Select Files To Relink-
Fensterbereich die bearbeitete Führungsspur-
Datei.

5 Ziehen Sie die ursprüngliche, nicht bearbeitete 
Audiodatei mit der Führungsspur in den 
Candidates-Fensterbereich. Wenn ein 
Dialogfeld mit dem Inhalt angezeigt wird, dass 
eine oder mehrere Dateien kürzer als die 
Mediendatei sind, die Sie neu koppeln möchten, 
klicken Sie auf Yes, um sie dennoch für eine 
Neukopplung auszuwählen.

6 Aktivieren Sie das Kästchen links von der Datei 
im Candidates-Fensterbereich sodass ein 
Verknüpfungssymbol angezeigt wird. 

7 Klicken Sie im oberen Bereich des Relink-
Fensters auf Commit Links und schließen Sie 
das Relink-Fenster anschließend.

Jetzt können Sie mit der rechten Maustaste auf den 
Namen der Führungsspur klicken und Expand To 

New Tracks > By Timecode Only wählen. Alle 
erweiterten Spuren sollten nun synchron mit der 
Führungsspur sein.

Film-Workflow
Dieser Abschnitt beschreibt den Film-Workflow 
vom Dreh bis zu dem Moment, wo der Avid-Cutter 
mit dem Schnitt beginnt, und richtet sich an 
folgende Gewerke:

• Kamera-Assistent/-in

• Kameramann/-frau

• Set-Tonmeister/-in

• Schnitt-Assistent/-in

• Pro Tools-Bearbeiter/-in

Übersicht über den Film-Workflow

Im Folgenden wird eine Übersicht über die 
notwendigen Schritte für einen Film-Workflow 
gegeben:

1 Drehvorbereitung

2 Dreh

Wenn die ursprüngliche, nicht bearbeitete 
Datei nicht verfügbar ist, können Sie eine 
Neukopplung mit einer beliebigen Audio-
Quelldatei vornehmen, solange diese 
dieselben Start- und Endzeiten wie die 
Führungsspur hat.



Pro Tools-Referenzhandbuch1252

3 Filmabtastung

4 Batch-Digitalisierung in der Avid-Video-
Editing-Anwendung

Das Befolgen dieser Schritte stellt sicher, dass 
Timecode-Metadaten vom Drehbeginn bis zur 
Auslieferung der Quelldateien an den Pro Tools-
Editor erhalten bleiben.

Drehvorbereitung (Film-
Workflow)
Vor Beginn jedes Drehtags sollte sich der Set-
Tonmeister für einen eindeutigen Namen 
entscheiden – vorzugsweise für einen, der mit 
jedem Tag eine höheren alphanumerischen Wert 
enthält. Den genauen Namen trägt er in das BEXT- 
oder iXML-Metadaten-Feld der Broadcast-WAV-
Datei des Aufnahmemediums ein. 

Beispielsweise könnte der Set-Tonmeister T001 
für den ersten Drehtag verwenden, T002 für den 
zweiten Drehtag und so weiter.

Drehen (Film-Workflow)
1 Die Dreharbeiten laufen folgendermaßen ab:

• Die Kamera läuft.

• Ein oder mehrere tragbare Rekorder nehmen den 
Ton auf. Der Set-Tonmeister hat einen oder zwei 
Kanäle als Set-Tonmischung bestimmt, wobei es 
sich um eine Zusammenlegung von einem oder 
mehreren Kanälen einer Mehrkanal-Aufnahme 
handelt.

2 Während des Drehs wird die folgende 
Timecode-Information erfasst:

• Die Kamera belichtet Bilder auf den Film, wobei 
jedes Einzelbild (auch Frame genannt) während 
der Herstellung mit einer eindeutig 
identifizierbaren Timecode-Position versehen 
wird, die auch als Keycode bekannt ist.

• Ein oder mehrere tragbare Rekorder gleichzeitig 
erstellen Mehrkanal-Aufnahmen, in die 
tageszeitbasierter SMPTE-Timecode (oder 
longitudinaler Timecode) eingebettet ist.

3 Während des Drehs werden folgende 
Informationen notiert:

• Der Kameraassistent führt Buch (auch Shotliste 
genannt) über jede Szene und jeden Take mit der 
entsprechenden Keycode-Position.

• Der Set-Tonmeister führt ebenfalls Buch (auch 
Sound-Log genannt) über jede Szene und jeden 
Take mit der entsprechenden Keycode-Position.

4 Der Kameraassistent betätigt die Klappe, um 
den Startpunkt für den Take zu markieren. Der 
tragbare Audiorekorder nimmt das Geräusch 
der Klappe auf, und die Filmkamera erfasst die 
folgenden Bilder:

• Szenen- und Take-Nummer (auf der Klappe 
angegeben)

• exakter Moment des Schließens der Klappe

• Timecode-Position des Schließens der Klappe

5 Der Dreh endet und das Take ist im Kasten.

Filmabtastung (Film-Workflow)
Am Ende des Drehtags erhält der Schnittassistent 
folgenden Materialien:

• entwickeltes Filmmaterial

• Mehrkanal Set-Ton 

• Shotliste und Sound-Log

Der Schnittassistent erzeugt die Muster (ein Video, 
das die Aufnahmen des Tages enthält), indem er 
Film und Ton auf ein Video überträgt. Diese 
Shotlisten dienen der Anleitung.
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So benutzen sie einen Filmabtaster zum Erzeugen 
der Muster:

1 Laden Sie Film und Ton in den Filmabtaster.

2 Geben Sie den Bandnamen oder den Namen der 
Tonrolle (je nachdem, was beim Dreh 
verwendet wurde) Zeichen für Zeichen in den 
Filmabtaster ein. 

3 Mit der Shotliste des Kamera-Assistenten 
lokalisieren Sie das Einzelbild, das die erste 
Keycode-Position des Filmmaterials in der 
Shotliste darstellt (es sollte eine Stelle kurz vor 
dem Schließen der Filmklappe sein).

4 Spulen Sie den Film an das erste Einzelbild, an 
dem sich die Klappe schließt und notieren Sie 
die Timecode-Position auf der Klappe.

5 Spulen Sie den Ton an exakt diese, auf der 
Klappe im oben beschriebenen Einzelbild 
angezeigten Timecode-Position, wodurch das 
Anlegen des Tons an das Bild ermöglicht wird.

6 Spielen Sie Film und Ton ab, um herauszufinden, 
ob sie synchron laufen. Falls Sie nicht synchron 
laufen, justieren Sie vorsichtig von Hand nach, 
bis Film und Ton synchron sind.

7 Sobald Film und Ton richtig synchron laufen, 
sorgen Sie dafür, dass die Lage von Film und 
Ton zueinander nicht mehr verändert 
werden kann.

8 Legen Sie eine leere Videokassette in den 
Videorekorder ein, der an den Filmabtaster 
angeschlossen ist, und weisen Sie dem 
Videoband manuell einen linearen Timecode 
(LTC) zu.

9 Nehmen Sie die Filmabtastung auf. Während 
der Aufnahme der Filmabtastung passiert 
Folgendes:

• Der Filmabtaster nimmt das mit dem Ton 
synchronisierte Bewegtbild auf und weist dabei 
dem Videoband linearen Timecode (LTC) ab der 
Stelle zu, für die Sie den Start-Timecode 
eingegeben haben.

• Eine FLEx-Datei wird erzeugt, wobei Szenen- 
und Take-Informationen automatisch 
geschrieben und in Bezug zum Film-Keycode 
und zum Timecode des Videobands im 
Filmabtaster gebracht werden, aus dem sich 
wiederum der Audio-Timecode herleiten lässt.

10 Sobald die Überspielung im Filmabtaster fertig 
ist, liefern Sie folgendes an den Avid-Cutter:

• das Videoband aus dem Filmabtaster

• die FLEx-Datei

• die Shotliste

• das Sound-Log

• die Set-Ton-Mediendateien

Um sicherzustellen, dass die Metadaten für 
den Pro Tools-Editor bewahrt werden, 
kommt es darauf an, den Bandnamen oder 
den Namen der Tonrolle Zeichen für Zeichen 
genau einzugeben. Wenn beispielsweise die 
Metadaten T001 (mit zwei Nullen) lauten, 
geben Sie T001 mit zwei Nullen ein – nicht 
T01 mit einer Null oder T0001 mit drei 
Nullen.
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Batch-Digitalisierung des 
Filmabtaster-Videobands 
(Film-Workflow)
Diese Phase des Workflows beginnt, nachdem der 
Avid-Cutter die folgenden Komponenten vom 
Schnittassistenten, der den Filmabtaster bedient, 
erhalten hat:

• das Videoband aus dem Filmabtaster

• die FLEx-Datei

• die Shotliste

• das Sound-Log

Bei einem Film-Workflow nimmt der Avid-Cutter 
eine Batch-Digitalisierung des Videobandes aus 
dem Filmabtaster vor, um die daraus entstehenden 
Video- und Audiodateien zu bearbeiten.

So nehmen Sie eine Batch-Digitalisierung des 
Filmabtaster-Videobands vor, um digitale 
Quelldateien zu erhalten:

1 Importieren Sie in der Avid-Video-Editing-
Anwendung alle relevanten FLEx-Dateien in 
Avid Log Exchange.

Avid Log Exchange zeigt eine Liste aller 
Kombinationen aus Szenen und Takes mit dem 
zugehörigen Film-Keycode, Audio-Timecode und 
dem zugehörigen Timecode des Videobands an.

2 Wählen Sie in Avid Log Exchange die Elemente 
der FLEx-Datei aus, die die Szenen und Takes 
darstellen, für die Sie eine Batch-
Digitalisierung vom Videoband vornehmen 
möchten.

3 Bearbeiten Sie die ausgewählten Szenen und 
Takes in der FLEx-Datei. Avid Log Exchange 
schickt die ausgewählten Elemente an die Avid-
Video-Editing-Anwendung, wo sie als Offline-
Medien in die Bin geladen werden.

4 Wählen Sie in der Avid-Bin die Elemente aus, 
die Sie aufnehmen möchten.

5 Laden Sie das Videoband aus dem Filmabtaster 
in die Avid-Anwendung und beginnen Sie mit 
der Batch-Digitalisierung.

Die Avid-Anwendung nimmt eine automatische 
Batch-Digitalisierung von Szenen und Takes vor 
und verwendet die FLEx-Datei, um jeder 
digitalisierten Video- und Audiodatei die 
Timecode-Information zuzuweisen, die der 
ursprünglichen Keycode- und Timecode-
Information vom Dreh entspricht.

6 Sobald die Batch-Digitalisierung abgeschlossen 
ist, benutzen Sie die Avid-Video-Editing-
Anwendung zur Audio- und Videobearbeitung.

7 Wenn Sie damit fertig sind, exportieren sie die 
bearbeiteten Sequenzen als AAF- oder OMF-
Sequenzen, damit sie in Pro Tools importiert 
werden können.

Video-Workflows und 
vollständig nonlineare 
Workflows
Dieser Abschnitt beschreibt sowohl Video- als 
auch völlig nonlineare Workflows vom Dreh bis 
zur Bearbeitung durch den Avid-Cutter und richtet 
sich an folgende Gewerke:

• Kamera-Assistent/-in

• Kameramann/-frau

• Set-Tonmeister/-in

• an Avid-Cutter

• Pro Tools-Bearbeiter/-in

Manchmal können Sie auch Set-Ton-
Mediendateien vom Set-Tonmeister erhalten.

Alle Metadaten, die für die Anpassung 
erforderlich sind (wie etwa Tape-Name), 
sollten in den undigitalisierten Clips 
sichtbar sein.
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Übersicht über Video- und ausschließlich 
nonlineare Workflows

Im folgenden wird eine Übersicht über die 
notwendigen Schritte für diese Workflows 
gegeben:

1 Drehvorbereitung

2 Dreh

3 Videodigitalisierung in der Avid-Video-
Editing-Anwendung (nur beim Video-
Workflow) oder direkter Import von 
Digitalvideo in die Avid-Video-Editing-
Anwendung (vollständig nonlinearer 
Workflow)

Das Befolgen dieser Schritte stellt sicher, dass 
Timecode- und andere Metadaten vom 
Drehbeginn bis zur Übermittlung der Quelldateien 
an den Pro Tools-Benutzer erhalten bleiben.

Drehvorbereitung (Video- und 
vollständig nonlineare 
Workflows)
Vor den Dreharbeiten sollten Kameramann und 
Set-Tonmeister Folgendes beachten:

• Der Ausgang des tragbaren Rekorders speist den 
Audio-Eingang der Videokamera.

• Tragbarer Rekorder und Videokamera sollten so 
verkoppelt werden, dass sie denselben 
Produktions-Timecode verwenden.

Anpassung von Bandnamen- an Tonrollen-
Metadaten für Videodreharbeiten

Bevor der Kameramann ein Videoband in die 
Kamera einlegt, sollte er es mit einem Etikett und 
dieses mit einem eindeutigen Namen versehen 
haben. Der Set-Tonmeister muss exakt diesen 
Namen auf dem Band in das BEXT- oder iXML-
Metadaten-Feld im Broadcast-WAV-File 
eingetragen haben. 

Anpassung von Bandnamen- an Tonrollen-
Metadaten für vollständig nonlineare 
Dreharbeiten

Nachdem er den Digitalvideospeicher in die 
Kamera geladen hat, versieht ihn der Kameramann 
mit einem eindeutigen Namen. Der Set-
Tonmeister muss exakt diesen Namen auf dem 
Band in das BEXT- oder iXML-Metadaten-Feld 
im Broadcast-WAV-File eingetragen haben. 

Drehen (Video- und vollständig 
nonlineare Workflows)
1 Die Dreharbeiten laufen folgendermaßen ab:

• Die Kamera läuft.

• Ein oder mehrere tragbare Rekorder nehmen den 
Ton auf. Der Set-Tonmeister hat einen oder zwei 
Kanäle als Set-Tonmischung bestimmt, wobei es 
sich um eine Zusammenlegung von einem oder 
mehreren Kanälen einer Mehrkanal-Aufnahme 
handelt.

2 Während des Drehs wird die folgende 
Timecode-Information erfasst:

• Die Kamera erfasst Bilder auf Video oder in 
Dateien und bettet darin einen tageszeitbasierten 
SMPTE-Timecode (oder longitudinalen 
Timecode) ein.

Nachdem Sie eine Datei mit den Metadaten 
des Bands in Pro Tools importiert haben, 
erscheinen die Metadaten im Sound Roll-
Feld des Workspace-Browsers.

Um sicherzustellen, dass die Metadaten für 
den Pro Tools-Bearbeiter bewahrt werden, 
kommt es darauf an, den Tape-Namen 
Zeichen für Zeichen exakt einzugeben. Wenn 
beispielsweise die Metadaten T001 (mit zwei 
Nullen) lauten, geben Sie T001 mit zwei 
Nullen ein – nicht T01 mit einer Null oder 
T0001 mit drei Nullen.
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• Ein oder mehrere tragbare Rekorder gleichzeitig 
erstellen Mehrkanal-Aufnahmen, in die 
tageszeitbasierter SMPTE-Timecode 
(oder longitudinaler Timecode) eingebettet ist.

3 Der Kameraassistent betätigt die Klappe, 
um den Startpunkt für den Take zu markieren. 
Der tragbare Audiorekorder nimmt das 
Geräusch der Klappe auf, und die Filmkamera 
erfasst die folgenden Bilder:

• Szenen- und Take-Nummer (auf der Klappe 
angegeben)

• exakter Moment des Schließens der Klappe

• Timecode-Position des Schließens der Klappe

4 Der Dreh endet und das Take ist im Kasten.

Digitalisieren eines Videobands 
in einer Avid-Video-Editing-
Anwendung
(Nur bei Video-Workflow)

Diese Phase des Workflows beginnt, nachdem der 
Avid-Cutter folgendes vom Kameramann und vom 
Set-Tonmeister erhalten hat:

• Videoband

• Mehrkanal-Aufnahmen

Bei einem Video-Workflow nimmt der Avid-
Cutter eine Batch-Digitalisierung des Videobands 
vor, um die daraus resultierenden Video- und 
Audiodateien zu bearbeiten. Davor muss der Avid-
Cutter jedoch das Band benennen.

So nehmen Sie eine Batch-Digitalisierung des 
Videobands vor, um digitale Quelldateien zu 
erhalten:

1 Laden Sie das Videoband in das Avid-System.

2 Bei der Eingabeaufforderung für den Namen 
des Videobands geben Sie den exakten Namen 
ein, den der Kameramann und der Set-
Tonmeister benutzt haben.

3 Digitalisieren Sie das im Avid-System 
befindliche Videoband.

4 Sobald die Digitalisierung abgeschlossen ist, 
benutzen Sie die Avid-Video-Editing-
Anwendung zur Audio- und Videobearbeitung.

Wenn Sie damit fertig sind, exportieren sie die 
bearbeiteten Sequenzen als AAF- oder OMF-
Sequenzen, damit sie in Pro Tools importiert 
werden können.

Importieren von Digitalvideo 
direkt in eine Avid-Video-
Editing-Anwendung
(Nur vollständig nonlinearer Workflow)

Diese Phase des Workflows beginnt, nachdem der 
Avid-Cutter folgendes vom Kameramann und vom 
Set-Tonmeister erhalten hat:

• Digitalvideo (auf Flash-Karten, 
Festspeicherlaufwerk oder anderen 
Datenträgern)

• Mehrkanal-Aufnahmen

In einem vollständig nonlinearen Workflow 
braucht der Avid-Cutter die Video- und 
Audiodateien nur zur Bearbeitung in die Avid-
Video-Editing-Anwendung zu importieren. 

Um sicherzustellen, dass die Metadaten für 
den Pro Tools-Bearbeiter bewahrt werden, 
kommt es darauf an, den Tape-Namen 
Zeichen für Zeichen exakt einzugeben. Wenn 
beispielsweise die Metadaten T001 (mit zwei 
Nullen) lauten, geben Sie T001 mit zwei 
Nullen ein – nicht T01 mit einer Null oder 
T0001 mit drei Nullen.
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So importieren Sie Video in die Avid-Video-
Editing-Anwendung:

1 Erstellen Sie eine Bin in der Avid-Video-
Editing-Anwendung.

2 Importieren Sie die Videodateien direkt in 
die Bin.

3 Sobald das Disk Label Import-Dialogfeld 
erscheint, geben Sie den exakten Bandnamen 
ein, den der Kameramann und der Set-
Tonmeister verwendet haben.

4 Benutzen Sie die Avid-Video-Editing-
Anwendung, um Audio und Video zu 
bearbeiten.

5 Wenn Sie damit fertig sind, exportieren sie die 
bearbeiteten Sequenzen als AAF- oder OMF-
Sequenzen, damit sie in Pro Tools importiert 
werden können.

Um sicherzustellen, dass die Metadaten für 
den Pro Tools-Bearbeiter bewahrt werden, 
kommt es darauf an, den Tape-Namen 
Zeichen für Zeichen exakt einzugeben. Wenn 
beispielsweise die Metadaten T001 (mit zwei 
Nullen) lauten, geben Sie T001 mit zwei 
Nullen ein – nicht T01 mit einer Null oder 
T0001 mit drei Nullen.
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Kapitel 52: Video in Pro Tools

Avid Video Engine (AVE)
Pro Tools verwendet die Avid Video Engine (AVE) 
zur Videowiedergabe. Mit der AVE können Sie 
gleichzeitig Desktopvideo (native Videos) anzeigen 
und Video über unterstützte Videoperipheriegeräte 
von Avid oder Drittanbietern ausgeben. Die AVE 
bietet Unterstützung für zahlreiche QuickTime-, 
Avid-HD- und -SD-MXF-Videoformate für 
Pro Tools-Videospuren ohne Transkodierung 
(einschließlich Avid DNxHD®).

So aktivieren Sie die Avid Video Engine für 
Pro Tools:

1 Wählen Sie Setup > Playback Engine.

2 Aktivieren Sie die Video Engine-Option, 
um Pro Tools mit der Avid Video Engine zu 
verwenden.

3 Klicken Sie auf OK.

Unterstützung für Avid-
Videoperipheriegeräte und 
Video-Hardware von 
Drittanbietern
Pro Tools und Pro Tools HD unterstützen das 
Monitoring auf externer Video-Hardware, 
die dafür ausgelegt ist. Pro Tools bietet mit der 
neuen Avid Video Engine Unterstützung für das 
Monitoring von DNxHD- und QuickTime-Medien 
über Avid Nitris® DX, Mojo® DX und andere von 
Avid qualifizierte Video-Interfaces anderer 
Hersteller.

So aktivieren bzw deaktivieren Sie Video-
Monitoring auf externer, dafür ausgelegter Video-
Hardware:

1 Vergewissern Sie sich, dass die von Avid 
stammende oder qualifizierte Video-Hardware 
richtig installiert und konfiguriert ist.

2 Aktivieren bzw. deaktivieren Sie Options > 

Enable Video Hardware.

Übersicht über Videofunktionen 
in Pro Tools und Pro Tools HD
Pro Tools bietet Ihnen die folgenden 
Möglichkeiten beim Editieren von Video:

• Erstellen einer einzelnen Videospur und 
Importieren von Avid- oder QuickTime-Videos 
in die Timeline mithilfe der Menübefehle oder 
der Drag & Drop-Funktion

• Organisieren, Gruppieren und Bearbeiten von 
Videoclips in der Timeline, ähnlich wie bei 
Audioclips

• Sperren von Videospuren

• Extrahieren von Audiodaten aus QuickTime

• Gleichzeitiges Scrubben von Audio und Video

• Anzeigen von Videoinhalten im Videofenster 
oder Ausgabe über ein von Avid unterstütztes 
Peripheriegerät an einen externen Monitor

• Bouncing der Videospur in QuickTime
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Pro Tools HD bietet Ihnen zusätzlich die 
folgenden Möglichkeiten:

• Importieren mehrerer Videodateien in 
die Timeline

• Erstellen und Editieren von bis zu 
64 Videospuren mit QuickTime und Avid-Video 
in der Timeline

• Auswählen aus mehreren Video-Playlists auf 
allen Videospuren

• Organisieren, Gruppieren und Bearbeiten von 
Videoclips gemeinsam mit Audioclips

• Verwalten mehrerer Videoclips in der Clipliste

• Rückgängigmachen mehrerer Video-Operationen

Unterstützung von 
QuickTime-Movies in 
Pro Tools
Pro Tools unterstützt Import, Wiedergabe und 
Bearbeitung von QuickTime-Movies. 

QuickTime erforderlich
Wenn Sie Movie-Dateien, MP3- oder MP4-Dateien 
(AAC) in Ihre Pro Tools-Sessions integrieren bzw. 
importieren möchten, benötigen Sie QuickTime. 
QuickTime für Windows kann kostenfrei von der 
Apple-Website (www.apple.com) heruntergeladen 
werden.

Unterstützte QuickTime-Movies
Wenn Sie mit einer Person zusammenarbeiten, 
die QuickTime-Movies zur Verwendung mit 
Pro Tools vorbereitet, stellen Sie sicher, dass Sie 
folgende Punkte absprechen:

Konsolidierte und Referenzmedien – QuickTime 
DV-Movies können entweder komplette 
(konsolidierte) QuickTime-Dateien (die alle Daten 
enthalten) oder Referenzdateien sein (QuickTime-
Dateien, die nur Verweise auf die ursprünglichen 
Mediendateien enthalten). 

Auf www.avid.com erfahren Sie, welche 
Version von QuickTime mit Ihrer Version von 
Pro Tools kompatibel ist.
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Vor dem Starten eines 
Projekts
Bevor Sie ein Projekt beginnen, bei dem mit Video 
gearbeitet werden soll, berücksichtigen Sie die 
folgenden Aspekte:

Frame Rate – informieren Sie sich über die 
jeweilige Framerate, bevor Sie Videoinhalte 
empfangen. Verwenden Sie diese Framerate dann 
beim Einrichten der Framerate Ihrer Pro Tools-
Sessions und bei der Aufzeichnung von Video.

Zur Erstellung verwendete Anwendung und 
Codec – bevor Sie Videodaten als Mediendateien 
erhalten, informieren Sie sich über die Anwendung 
und den Codec, die zur Erstellung der Dateien 
verwendet wurden. Vergewissern Sie sich, dass 
Sie diese Dateien in Pro Tools abspielen können. 
Es empfiehlt sich, grundsätzlich zunächst eine 
Probedatei zu testen.

Einbrennen des Video-Timecodes – verlangen 
Sie vor dem Entgegennehmen von Videodateien, 
dass der Timecode nach Möglichkeit „eingebrannt“ 
(überkopiert) wird. Hiermit wird sichergestellt, 
dass Pro Tools die Datei an der richtigen 
Timecode-Position in der Timeline platziert.

Ausreichend Speicherplatz auf Video-
Festplatten – vergewissern Sie sich, dass 
genügend Speicherplatz auf mehreren dedizierten 
Laufwerken nur für Videodaten verfügbar ist. 
Videodateien benötigen deutlich mehr 
Speicherplatz und Bandbreite als Audiodateien. 
Es wird daher empfohlen, sie getrennt von 
Audiodateien auf separaten Laufwerken zu 
speichern, um Leistungsprobleme zu vermeiden.

Separate Laufwerke für Video- und Audiodaten – 
beste Ergebnisse erzielen Sie, wenn Sie getrennte 
Festplatten für Video- und für Audioinhalte 
benutzen. Ausführliche Informationen zu den 
Festplattenanforderungen finden Sie auf 
www.avid.com

Voreinstellungen für 
Pro Tools-Video

Der Video-Bereich der Pro Tools Operation-
Voreinstellungen verfügt über folgende Optionen:

Enable GPU

Die Pro Tools-Videoverarbeitung läuft über die 
GPU (Grafikprozessor), um Prozessor-Ressourcen 
für Pro Tools-Audio und -MIDI zu schaffen. 
Wenn Sie eine langsamere GPU verwenden und 
dadurch eine mangelhafte Videowiedergabe 
erhalten, können Sie diese Option deaktivieren 
und die Videoverarbeitung über den Prozessor 
laufen lassen.

Prevent Tearing

Wenn aktiviert, puffert Pro Tools Video, damit bei 
horizontaler Bewegung keine Artefakte 
erscheinen, wenn die Videosynchronisation nicht 
der Aktualisierungsrate des Bildschirms 
entspricht. Diese Option ist nicht verfügbar, wenn 
die Enable GPU-Option deaktiviert ist.

Neue Video-Optionen in den „Pro Tools Operation“-
Voreinstellungen
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Enable Hardware During Scrub

Wenn die Option Enable Hardware During Scrub 
aktiviert ist, können Sie per Hardware (z. B. Avid 
Mojo DX oder Nitris DX-Video-Peripheriegeräte) 
beim Scrubben eine Videovorschau anzeigen. Bei 
deaktivierter Option können Sie beim Scrubben 
nur im Videofenster von Pro Tools die 
Videovorschau anzeigen. Wenn beim Monitoring 
von Video unter Verwendung von Videohardware 
beim Scrubben Leistungsprobleme auftreten, 
sollten Sie diese Option deaktivieren.

Play Start Latency

Wenn Sie auf einem langsameren Computer 
arbeiten, sollten Sie die Play Start Latency-
Einstellung auf einen höheren Wert setzen. Der 
Wert kann 1-Shortest bis 5-Longest betragen.

Videospuren
Mit Videospuren können Sie Videoinhalte in der 
Timeline wie folgt einfügen oder importieren:

• In Pro Tools können Sie eine Videospur pro 
Session hinzufügen oder importieren. Jede 
Videospur kann jeweils nur eine Video-Playlist 
und eine Avid- oder QuickTime-Videodatei 
enthalten.

• In Pro Tools HD können Sie der Timeline 
mehrere Videospuren hinzufügen sowie mit 
mehreren Video-Playlists und mehreren 
Videodateien pro Spur arbeiten.

• Außerdem können Sie QuickTime- und Avid-
Videospuren in der Timeline (aber nicht auf 
derselben Videospur) mischen. 

Führen Sie einen der folgenden Schritte aus, um 
eine Videospur in Pro Tools zu erstellen:

 Wählen Sie „File > Import“ zum Importieren 
einer Videodatei. 

 Ziehen Sie eine Videodatei in die Timeline. 

 Mit File > Import > Session Data importieren 
Sie eine Session oder AAF-Sequenz mit 
Videospuren.

Weitere Informationen finden Sie unter 
„Importieren von Video in Pro Tools“ auf 
Seite 1273.

So erstellen Sie eine neue Videospur mit 
Pro Tools HD:

1 Wählen Sie Track > New.

2 Wählen Sie im Track Type-Popup-Menü die 
Video Track-Option.

3 Geben Sie die Anzahl der neuen Videospuren 
ein.

4 Klicken Sie auf Create.

Eine neue, leere Videospur wird angezeigt. 
Videospuren können je nach Systemkonfiguration 
oder hinzugefügtem Videotyp geringfügig 
variieren.

Mehrere Videospuren in der 
Timeline
(Nur Pro Tools HD)

Sie können der Timeline mehrere Videospuren 
hinzufügen, aber jeweils nur eine Videospur 
wiedergeben. Diese Spur wird als Haupt-
Videospur bezeichnet.

Leere Videospur
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Mehrere Videospur-Playlists
(Nur Pro Tools HD)

Playlists bieten eine einfache Möglichkeit, 
zwischen alternativen Versionen einer Videospur 
zu wechseln.

Sie können sämtliche Operationen, die Sie mit 
Audio-Playlists vornehmen können, auch mit 
Video-Playlists durchführen, darunter:

• Duplizieren einer Playlist

• Erstellen einer Playlist

• Zuweisen einer Playlist zu einer anderen 
Videospur

• Umbenennen einer Playlist

• Löschen einer Playlist

Mehrere Codecs auf einer 
einzelnen Videospur
(Nur Pro Tools HD)

Eine einzelne Videospur kann Videoclips, die mit 
verschiedenen Video-Codecs desselben Videotyps 
komprimiert wurden, enthalten. Sie können 
beispielsweise QuickTime-Dateien, die unter 
Verwendung mehrerer Codecs komprimiert 
wurden, auf derselben Videospur hinzufügen.

Allerdings müssen nach dem Hinzufügen des ersten 
Videos zu einer Session sämtliche zusätzlich der 
Timeline hinzugefügten Videodateien dieselbe 
Framerate wie die erste Videodatei aufweisen. 

Haupt-Videospur
Die Haupt-Videospur ist die Spur, die aktuell 
online ist und zusammen mit Audioinhalten in der 
Session wiedergegeben wird. 

Wenn die Haupt-Videospur offline ist, können Sie 
die Audioinhalte aus Ihrer Session wiedergeben, 
ohne das Video abzuspielen. Ist das Video offline, 
ändert sich die Farbe der Video-Online-
Schaltfläche in Grau, damit Sie sofort erkennen, 
ob Ihr Video offline ist oder ob einfach schwarzes 
Füllsignal wiedergegeben wird.

Wenn gegenwärtig keine Videospur online ist, 
wird die Videospur, die zuletzt online war, als 
Haupt-Videospur angesehen.

So wählen Sie die Haupt-Videospur:

 Klicken Sie auf die Video Online-Schaltfläche 
für eine beliebige Spur, die offline (grau) ist, 
und schalten Sie sie online (blau). Die Spur 
wird nun als Haupt-Videospur angesehen. 

Weitere Informationen finden Sie unter 
Kapitel 29: „Playlists“.

Video Online-Schaltfläche (online)
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Videospur-Steuerelemente 
und -Anzeigen

Videospurdarstellung
Die Videospur kann in der Frame- oder der 
Blockdarstellung angezeigt werden. Bei beiden 
werden alle Clipgrenzen und Metadaten angezeigt. 
Videobilder werden nur in der Framedarstellung 
angezeigt.

So legen Sie die Darstellung für die Videospur fest:

 Wählen Sie auf der Videospur aus dem View 
Options-Popup-Menü (Anzeigeoptionen) den 
Modus „Frames“ oder „Blocks“ aus.

Framedarstellung
In der Framedarstellung werden Videodaten in 
der Videospur als Bilder angezeigt. Diese 
Bilder werden basierend auf dem Videobild 
verarbeitet und entsprechend Ihrer Zoom- und 
Höheneinstellungen für die Spur skaliert. 
Sie ermöglichen Ihnen, schnell eine Szene oder 
Sequenz in der Videospur zu finden.

Bilder werden nicht ordnungsgemäß angezeigt, 
wenn Sie während der Wiedergabe die Zoom-
Einstellungen ändern. Es werden leere Frames 
angezeigt, bis die Wiedergabe beendet wird. 
Sie sollten die Wiedergabe stoppen, bevor Sie die 
Zoom-Einstellungen ändern, wenn Sie Bilder 
anzeigen möchten.

Wenn Video-Pull-Up oder -Pull-Down aktiviert 
ist, ändern Bilder ihre Position nicht.

Framedarstellung und Verarbeitungsleistung

Wenn Sie Ihr Video auf der Videospur in der 
Framedarstellung anzeigen, wird die 
Rechenleistung Ihres Computers möglicherweise 
beeinträchtigt. Ist das der Fall, sollten Sie die 
Videospur ausblenden oder in die 
Blockdarstellung wechseln.

Blockdarstellung
In der Blockdarstellung werden Videobilder durch 
farbige Blocks ersetzt. 

Beim Wechsel vom Block- zum Frame-Modus 
während der Wiedergabe wird die Anzeige 
der Videospur erst auf Frames aktualisiert, 
wenn die Wiedergabe gestoppt wird.

Videospur in Framedarstellung

Videospur in Blockdarstellung
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Bildsymbole für verschiedene 
Videospurarten
Für eine Videospur wird ein QuickTime-Symbol 
angezeigt, wenn sich ein QuickTime-Video auf der 
Spur befindet. Für Avid-Video und bei leeren 
Videospuren wird kein Symbol angezeigt.

Sie können einer leeren Videospur beliebige 
unterstützte Videoformate hinzufügen.

Video Online-Schaltfläche
Mit der Video Online-Schaltfläche können Sie die 
Haupt-Videospur auswählen, die Spur online oder 
offline schalten und auf einen Blick anhand der 
Farbe erkennen, ob eine Videospur offline (grau) 
oder online (blau) ist.

So schalten Sie eine Videospur online oder offline:

 Klicken Sie auf die Video Online-Schaltfläche 
für eine beliebige Spur, die offline (grau) ist, 
und schalten Sie sie online (blau). Die Spur 
wird nun als Haupt-Videospur angesehen. 

 Klicken Sie auf die Video Online-Schaltfläche 
der Haupt-Videospur, um sie offline zu schalten. 
Pro Tools gibt nun kein Video mehr aus.

Videospur-Einstellungen
Pro Tools bietet Videospur-Einstellungen für 
Projekttyp, Ausgabe und Videoqualität bei der 
Wiedergabe.

So blenden Sie die Videospur-Steuerelemente ein 
bzw. aus:

 Aktivieren bzw. deaktivieren Sie View > Edit 

Window Views > I/O.

Projekttyp
In Pro Tools sind keine gemischten Framerates 
möglich, aber verschiedene Auflösungen. Über 
den Project Type-Selektor können Sie den 
Projekttyp (Auflösung) einstellen, der am besten 
den gemischten Auflösungen in der Session 
entspricht. Im Allgemeinen müssen Sie den 
Projekttyp nicht ändern.

Videospuren mit QuickTime-Symbol

Video Online-Schaltfläche: offline (oben) und online 
(unten)

QuickTime-
Symbol

Bei Pro Tools HD drücken Sie Shift + J, um 
alle angezeigten Videospuren zu durchlaufen 
und online geschaltete Spuren zu identifizieren.

Neue Videospur-Steuerelemente

Projekttyp
Videoqualität
Output-
Einstellungen



Pro Tools-Referenzhandbuch1266

Für Avid-MFX-Video ist der Projekttyp 
automatisch eingestellt. Wenn Sie jedoch mit 
gemischten Auslösungen arbeiten, können Sie die 
geeignetste Auflösung für die Session über die 
Project Type-Einstellungen festlegen.

Es sind Projekttypen mit folgenden 
Videoauflösungen verfügbar (abhängig von 
Medien- und Session-Setup):

* Das Videoausgabeformat wird eventuell auf dem 
externen Monitor angezeigt.

QuickTime-Medien

Beim Importieren eines QuickTime-Movies gelten 
folgende Bedingungen:

In Pro Tools werden Framerate und der Project 

Type während des Imports automatisch eingestellt, 
basierend auf der Framerate und Auflösung des 
QuickTime-Movies.

Wenn mehrere Projekttypen möglich sind, können 
Sie den Projekttyp aus den bestmöglichen 
Abstimmungen auswählen.

Wenn die Framerate in der Nähe eines ganzen 
Wertes ist, rundet Pro Tools auf die nächste 
Framerate auf oder ab (zum Beispiel wird 29,972 
abgerundet auf 29,97).

Unterstützte Videoformate

Video 
Format

Videoreferenz-
Rate

Pro Tools-
Framerate

Video-
ausgabe-
format*

30i 
NTSC

NTSC 29,97 NTSC

25i PAL PAL 25 PAL

23,976p 
NTSC

NTSC 23,976 NTSC

24p 
NTSC

NTSC 24 NTSC

24p PAL PAL 24 PAL

25p PAL PAL 25 PAL

720p / 
23,976

720p / 59,94 
oder NTSC

23,976 720p /
59,94

720p /
25

720p / 25 oder 
PAL

25 720p / 25

720p / 
29,97

720p / 59,94 
oder NTSC

29,97 720p / 
59,94

720p /
50

720p / 50 oder 
PAL

25 720p / 50

720p / 
59,94

720p / 59,94 
oder NTSC

29,97 720p / 
59,94

1080i / 
50

1080i / 50 oder 
PAL

25 1080i / 50

1080i / 
59,94

1080i / 59,94 
oder NTSC

29,97 1080i / 
59,94

1080p / 
23,976

1080psf / 
23,98

23,976 1080psf /
23,98

1080p / 
24

1080psf /
24

24 1080psf /
24

1080p / 
25

1080psf / 50 
oder PAL

25 1080psf / 
50

1080p / 
29,97

1080psf / 
29,97 oder 
NTSC

29,97 1080psf / 
29,97

Unterstützte Videoformate

Video 
Format

Videoreferenz-
Rate

Pro Tools-
Framerate

Video-
ausgabe-
format*
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Ändern Sie bei importierten QuickTime-Medien 
eines unbekannten Projekttyps (wie etwa 
Standbilder oder Bildschirmfotos) die Project Type-
Einstellung, um eine optimale Anpassung an in der 
Session vorhandenes Videomaterial zu erreichen.

Output-Einstellungen
Pro Tools verfügt über ein Output-
Einstellungsfenster für die Konfigurierung Ihres 
Videoperipheriegeräts von Avid oder eines von 
Avid qualifizierten Peripheriegeräts eines 
Drittanbieters. Die Output-Einstellungen werden 
im System gespeichert. Die Schaltfläche für die 
Output-Einstellungen ist nicht verfügbar, wenn Sie 
ohne ein Videoperipheriegerät Video bearbeiten.

So konfigurieren Sie die Output-Einstellungen für 
Ihr Videoperipheriegerät:

1 Klicken Sie in einer vorhandenen Videospur 
oder in einer neu erstellten Videospur auf die 
Output Settings-Schaltfläche.

2 Wenn Avid Mojo DX oder Avid Nitris DX 
verbunden ist, wird das Video Output Tool 
geöffnet. Wenn ein Videoperipheriegerät eines 
Drittanbieters verbunden ist (wie zum Beispiel 
ein von Avid unterstütztes Videoperipheriegerät 
von Blackmagic oder AJA), wird dessen 
Bedienfeld geöffnet.

3 Konfigurieren Sie nach Belieben die Output-
Einstellungen für Ihr Avid Videoperipheriegerät 
oder die Bedienoberfläche von 
Drittanbietergeräten.

Output-Einstellungsoptionen

Klicken Sie im „Video Output Tool“-Fenster auf 
die Options-Registerkarte , um die Optionen für 
die Videoausgabe zu konfigurieren, die für Ihre 
Videohardware und Ihren Projekttyp relevant sind.

Abhängig von der Videohardware, dem Projekttyp 
und den Videoauflösungen sind eine oder 
mehrere der folgenden Optionen im „Video Output 
Tool“-Dialogfeld verfügbar. Das Video Output 
Tool ist nicht verfügbar bei Systemen, die keine 
Avid-Videohardware verwenden. Bei Systemen, 
die Hardware von Drittanbietern verwenden 
(wie von Avid unterstützte Videoperipheriegeräte 
von Blackmagic oder AJA), wird über die „Output 
Settings“-Schaltfläche die Bedienoberfläche für 
Ihre Videohardware geöffnet.

Klicken Sie bei gedrückter Strg-Taste 
(Windows) bzw. Befehlstaste (Mac), um den 
Projekttyp auszuwählen.

Video Output Tool, Options-Registerkarte 
(Nitris DX-Hardware)
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Sync Lock

Die Sync Lock-Einstellung synchronisiert Ihr 
Videoperipheriegerät mit einer externe Referenz 
oder einem internen Taktgeber. Pro Tools erkennt 
automatisch den Typ Ihrer Avid-Videohardware 
und zeigt eine der folgenden Optionen an:

• Mojo DX-Optionen:

• Internal

• Reference

• Nitris DX-Optionen:

• Internal

• Loop Through

• Ref 1

• Ref 2

Wenn SYNC HD installiert und aktiviert ist und 
im Session Setup-Fenster Clock Reference auf 
Video Reference eingestellt wurde, werden die 
vorgeschlagenen Formate im Video Ref Format-
Selektor des Session Setup-Fensters 
hervorgehoben angezeigt.

HDMI-Farbraum

Die HDMI Color Space-Optionen sind dynamisch, 
abhängig davon, ob Mojo DX oder Nitris DX 
verbunden ist und von anderen Einstellungen. 
Die HDMI Color Space-Einstellung legt den 
Farbstandard (entweder „YCbCr“ oder „Convert 
to RGB“) für Ihre HDMI(High-Definition 
Multimedia-Interface)-Ausgabe fest. Dazu muss 
an Ihrem System HDMI-kompatible Avid-
Videohardware angeschlossen sein.

HDMI-Format

Für SD-Video bietet die Einstellung folgende 
Optionen:

• SD Interlaced

• SD Progressive

Output PSF or True Progressive

Bei HD-Video lässt sich über diese Einstellung die 
Hardware zwischen PSF- und Progressive-Output-
Formaten umschalten:

• PSF Output

• True Progressive

NTSC Has Setup

Diese Option legt die korrekte Farbzuordnung für 
Systeme fest, je nachdem, ob Sie NTSC-EIAJ 
verwenden oder nicht. NTSC-EIAJ-Benutzer 
sollten diese Option nicht auswählen. Alle anderen 
Benutzer sollten diese Option auswählen.

Video Reference-Formate im Session-Setup-Fenster
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Kalibrierungseinstellungen im Video 
Output Tool
(Nur Nitris DX)

Klicken Sie im „Video Output Tool“-Fenster 
auf die Registerkarte Calibration, um die 
Kalibrierungseinstellungen für die Videoausgabe 
zu konfigurieren.

Output-Menü für Nicht-HD-Video

Mit dem Output-Selektor können Sie Component, 
Composite oder S-Video für Nicht-HD-Projekte 
auswählen.

Bei einigen Systemen sind alle Ausgänge auf Ihrer 
Videohardware aktiv. Wählen Sie ein Analogsignal 
aus dem Ausgangs-Menü, um den Ausgang zu 
kalibrieren.

Hue – damit kann ein Attribut der 
Farbempfindung der variablen Anteile von Rot, 
Grün und Blau im Videosignal (auch bekannt als 
Farbphase) angepasst werden. Verfügbar für die 
S-Video- oder Composite-Ausgabe.

Sat – damit kann die Sättigung angepasst werden, 
ein Wert für die Chrominanz bzw. Farbintensität 
des Videosignals. Verfügbar für die S-Video- oder 
Composite-Ausgabe.

SC Phase – damit kann die Farbträgerphase 
(der Farb-Burst-Teil eines Signals für die zeitliche 
Synchronisation von zwei oder mehr 
Videosignalen) angepasst werden. Verfügbar für 
die S-Video- oder Composite-Ausgabe.

Setup – damit kann die relative Helligkeit und 
Dunkelheit von Bildern angepasst werden. 
Verfügbar für die S-Video-, Component- oder 
Composite-Ausgabe.

Gain – damit kann die Variation der hellsten oder 
farbärmsten Bildteile im Vergleich zu den 
dunkelsten Bildteilen angepasst werden. Verfügbar 
für die S-Video- oder Composite-Ausgabe.

Y Gain, Pr Gain, Pb Gain – nur für die 
Component-Ausgabe verfügbar.

Y Gain – damit kann der Y-Gain eingestellt 
werden, der Luminanz-Wert (Y) des Videosignals. 
Luma ist der weißeste Punkt im sichtbaren Bild. 
Verwenden Sie Farbleisten, um den Weißgrad 
einzustellen.

Pb Gain – damit kann bei einem analogen 
Komponentensignal der Gain des Pb-
Farbdifferenzsignals (eine skalierte Version des 
BY-Signals) angepasst werden.

Pr Gain – damit kann bei einem analogen 
Komponentensignal der Gain des Pr-
Farbdifferenzsignals (eine skalierte Version des 
RY-Signals) angepasst werden.

Video Output Tool, Calibration-Registerkarte 
(Composite-Ausgabe ausgewählt)
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System Phase

Bei einigen Avid-Videohardware-Konfigurationen 
können Sie das Timing des Ausgangssignals und 
ein Referenzsignal modulieren. Diese Option ist 
verfügbar für die S-Video-, Component- oder 
Composite-Ausgabe.

SubPixel HPhase

Die SubPixel HPhase-Einstellung bietet eine 
Feinanpassung der Horizontalphase. Verfügbar 
für die S-Video-, Component- oder Composite-
Ausgabe.

Output-Menü für HD-Video

Im Output-Menü können Sie dieHD Component-
Ausgabe, Convert to HD Component RGB oder 
HD Component YPbPr auswählen.

Gain – damit kann der Luminanz-Wert (Y) des 
Videosignals angepasst werden. Luma ist der 
weißeste Punkt im sichtbaren Bild. Verwenden 
Sie Farbleisten, um den Weißgrad einzustellen. 
Bei einigen Systemen verfügbar für die 
HD Component RGB- oder 
HD Component YPbPr-Ausgabe.

Pb Gain – bei einigen Avid-Videohardware-
Konfigurationen können Sie über die Pb Gain-
Einstellung den Gain des Pb-Farbdifferenzsignals 
anpassen, skaliert von BY über den BT.709-
Farbraum im HD-Komponenten-Systemen. Diese 
Einstellung ist verfügbar für die 
HD Component YPbPr-Ausgabe.

Pr Gain – bei einigen Avid-Videohardware-
Konfigurationen können Sie bei einem analogen 
Komponentensignal über die Pr Gain-Einstellung 
den Gain des Pr-Farbdifferenzsignals (eine 
skalierte Version des RY-Signals) anpassen. 
Nur für die Component-Ausgabe verfügbar.

System Phase

In der System Phase-Einstellung können Sie das 
Timing des Ausgabesignals und eines 
Referenzsignals modulieren. Diese Option ist 
verfügbar für die HD Component RGB- oder 
HD Component YPbPr-Ausgabe.

Sub Pixel H Phase

Über die Sub Pixel H Phase-Einstellung können 
Sie die horizontale Austastlücke anpassen, die für 
die zeitliche Synchronisation von zwei oder mehr 
Videosignalen verwendet wird. Die Sub Pixel H 

Phase-Einstellung ist bei einigen Systemen 
verfügbar für die S-Video-, Component- oder 
Composite-Ausgang.

Videoqualität
Verwenden Sie den Videoqualitäts-Selektor, um die 
Videoqualität für die Wiedergabe der Spur 
einzustellen. Sie können unter Optionen auswählen, 
die von bestmöglicher Leistung (niedrigere 
Videoqualität) bis zu voller Qualität reichen.

Die folgenden Optionen sind vorhanden:

Full Quality

Wählen Sie die Full Quality-Option, um das 
Vollbildraster für das Projekt zu verarbeiten und 
wiederzugeben. Full Quality verwendet eine 
Bittiefe von 8 Bits. Diese Option liefert die 
höchste Video-Wiedergabequalität durch die 
Verarbeitung jedes Bildpixels. Bei Interlaced-
Projekten verarbeitet diese Option die volle Breite 
jeder Zeile in beiden Halbbildern. Bei Progressive-
Projekten verarbeitet diese Option die volle Breite 
jeder Abtastungszeile.
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Full Quality 10-bit

Wählen Sie die Full Quality 10-bit-Option, um das 
Vollbildraster für das Projekt zu verarbeiten und 
wiederzugeben. Diese Option verwendet eine 
Bittiefe von 10 Bits, die eine höhere 
Verarbeitungsqualität liefert. Diese Option ist nur 
bei angeschlossener Video-Hardware verfügbar.

Draft

Wählen Sie die Draft-Option, um das 
Vollbildraster für das Projekt zu verarbeiten und 
wiederzugeben, das 1/4 der Bildinformationen 
verwendet. Die Draft-Option verwendet eine 
Bittiefe von 8 Bits. Diese Option verringert die 
Rasterbreite um 50 %. Bei Interlaced-Projekten 
wird bei dieser Option ein Halbbild verwendet. 
Bei Progressive-Projekten werden bei dieser 
Option 50 % der Abtastungszeilen verwendet.

Best Performance

Wählen Sie die Best Performance-Option, um das 
Vollbildraster für das Projekt mit 1/16 der 
Bildinformation zu verarbeiten und wiederzugeben. 
Die Best Performance-Option verwendet eine 
Bittiefe von 8 Bits. Diese Option verringert die 
Rasterbreite auf 25 %. Bei Interlaced-Projekten 
werden bei dieser Option 50 % der Zeilen in 
einem Halbbild verwendet. Bei Progressive-
Projekten werden bei dieser Option 25 % der 
Abtastungszeilen verwendet. Diese Option ist nicht 
verfügbar, wenn Video-Hardware eines 
Drittanbieters verwendet wird.

Sperren von Videospuren
Sie können eine oder mehrere Videospuren 
sperren, sodass keine Videoclips auf diesen Spuren 
mehr bearbeitet werden können.

Wenn eine Videospur gesperrt ist, lässt Pro Tools 
keinerlei Bearbeitungsvorgänge an der Spur zu 
(ausgenommen Sperren und Entsperren von 
Videoclips).

Eine gesperrte Videospur ist mit einem kleinen 
Schloss gekennzeichnet, das darauf hinweist, dass 
die Videospur gesperrt wurde und nicht bearbeitet 
werden kann. (Das Schloss wird nicht angezeigt, 
wenn die Spurhöhe der Videospur auf „Mini“ 
festgelegt wurde.)

So sperren Sie eine Videospur:

1 Wählen Sie die zu sperrenden Videospuren aus.

2 Sie haben folgende Möglichkeiten:

• Halten Sie die Windows-Taste (Windows) oder 
Ctrl-Taste (Mac) gedrückt, klicken Sie auf den 
Namen der gewünschten Videospuren und 
wählen Sie Locked (gesperrt).

• Klicken Sie mit der rechten Maustaste auf den 
Namen einer beliebigen Videospur und wählen 
Sie Locked.

Durch Sperren oder Entsperren einer Videospur 
wird der Sperrstatus der einzelnen Clips nicht 
verändert. Wenn ein Clip vor dem Sperren der 
Spur gesperrt war, bleibt er auch nach dem 
Entsperren gesperrt. Wenn Sie einen Clip in einer 
gesperrten Spur entsperren, können Sie ihn danach 
dennoch nicht bearbeiten. Die Inhalte bleiben so 
lange gesperrt, bis Sie die Spur entsperren.

Sie können einzelne Videoclips für die 
Bearbeitung oder für bestimmte Zeiten 
sperren. Weitere Informationen über das 
Sperren von Clips finden Sie unter „Sperren 
von Clips“ auf Seite 864.
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Video-Engine-Rate
Die Video-Engine-Rate zeigt an, wie viele 
Videobilder Pro Tools pro Sekunde ausgibt. Die 
Rate wird automatisch durch die Framerate der 
ersten einer Session hinzugefügten Video-Datei 
festgelegt. Video-Dateien, die nachfolgend zur 
Session hinzugefügt werden, müssen über dieselbe 
Video-Framerate wie die Video-Engine-Rate 
verfügen.

Die Video-Framerate jeder Videodatei wird in den 
Workspace-Browsern angezeigt. Die aktuelle 
Video-Engine-Rate wird im I/O-Bedienfeld der 
Hauptvideospur angezeigt.

Die Video-Engine-Rate ist unabhängig von der 
Timecode-Rate der Session, die die Anzahl der 
Bilder, die in Rastern, Leisten und Zählern 
angezeigt werden, bestimmt. Sie können die 
Timecode-Rate der Session im Session Setup-
Fenster manuell über das Timecode Rate-Popup-
Menü festlegen. Damit die Raster und Leisten an 
den Bildern in der Timeline ausgerichtet werden 
können, sollten Sie die Timecode-Rate-
Einstellung so festlegen, dass sie mit der Video-
Engine-Rate übereinstimmt.

Video-Engine-Rate-Anzeige
Die Video-Engine-Rate-Anzeige wird nur in der 
Haupt-Videospur angezeigt (unabhängig davon, 
ob diese online oder offline ist) und liefert 
Informationen zur Video-Engine-Rate, also die 
Anzahl der von Pro Tools pro Sekunde 
ausgegebenen Videobilder. 

Die Video-Engine-Rate-Anzeige ist 
normalerweise weiß, wird aber unter folgenden 
Bedingungen rot:

• Die Video-Engine-Rate stimmt nicht mit der 
aktuellen Timecode-Rate-Einstellung der 
Session überein.

• Am Video wurde ein Pull-Up vorgenommen, 
wodurch sich die Video-Engine-Rate von der 
Timecode-Rate der Session unterscheidet.

Weitere Informationen zur Video-Engine-
Rate-Anzeige im I/O-Bedienfeld finden Sie 
unter „Video-Engine-Rate-Anzeige“ auf 
Seite 1272.

Video-Framerate

Die Timecode-Rate wird im Session Setup-
Fenster festgelegt. Weitere Informationen 
finden Sie unter „Session Setup-Fenster“ auf 
Seite 1203.

Weitere Informationen zur Verwendung von 
Video-Pull-Up und -Pull-Down finden Sie 
unter „Pull-Up und Pull-Down“ auf 
Seite 1212.
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Importieren von Video in 
Pro Tools
Pro Tools bietet die folgenden Methoden zum 
Importieren von Videodateien in die Timeline, die 
Clipiste oder neue bzw. bestehende Videospuren:

• Import Video-Befehl (File > Import > Video)

• Ziehen aus der Clipliste in die Timeline 
(nur Pro Tools HD)

• Drag & Drop aus einem Workspace-Browser 
oder aus dem Windows-Explorer bzw. 
Mac Finder

• Import Session Data-Befehl anwenden (File > 

Import > Session Data) – hiermit können Sie 
Video aus einer anderen Pro Tools-Session oder 
aus einer AAF- oder OMF-Datei, aber keine 
einzelnen Videodateien importieren

Importieren von Video in 
Pro Tools mithilfe des Import 
Video-Befehls
Mit dem Menübefehl „Import Video“ können Sie 
eine oder mehrere Videodateien auswählen, die in 
Pro Tools importiert werden sollen. 

Wenn Sie diese Methode zum Importieren von 
Video in Pro Tools verwenden, wird das Video 
Import Options-Dialogfeld angezeigt. Dieses 
Dialogfeld enthält verschiedene Optionen zur 
Anpassung der Vorgehensweise beim Importieren 
von Dateien.

So importieren Sie Video mithilfe des Import 
Video-Befehls in Pro Tools:

1 Sie haben folgende Möglichkeiten:

• Wählen Sie File > Import > Video.

• Drücken Sie Befehl + Wahl + Umschalt + I 
(Mac). bzw. Strg + Alt + Umschalt + I 
(Windows).

2 Wählen Sie im Select Video File to Import-
Dialogfeld eine oder mehrere Videodateien aus.

3 Klicken Sie auf Open.

4 Nehmen Sie im Video Import Options-
Dialogfeld die gewünschte Konfiguration vor 
und klicken Sie auf „OK“, um das 
Videomaterial in Pro Tools zu importieren.

Die Video-Framerate der ersten einer 
Session hinzugefügten Videodatei legt die 
Video-Engine-Rate der Session fest. Video-
Dateien, die nachfolgend zur Session 
hinzugefügt werden, müssen über dieselbe 
Video-Framerate wie die Video-Engine-Rate 
verfügen.

Grundsätzlich sollten Audio- und 
Videomedien auf separaten, dedizierten 
Laufwerken gespeichert werden. Beim 
gleichzeitigen Importieren von Audio und 
Video durch Verknüpfen mit Medien kopiert 
Pro Tools jedoch möglicherweise beides auf 
dasselbe Laufwerk. Um Leistungsprobleme 
zu vermeiden, verschieben Sie Videodateien 
auf eine Festplatte für die Videowiedergabe, 
bevor Sie Audio und Video in Ihre Session 
importieren. 

In einem Workspace-Browser können Sie 
festlegen, dass Ihre Audiolaufwerke nur 
Audioinhalte wiedergeben oder aufnehmen, 
Videoinhalte hingegen lediglich übertragen, 
oder umgekehrt. Mit diesen Einstellungen 
stellen Sie sicher, dass sich Ihre Audio- und 
Videodaten auf den richtigen Laufwerken 
befinden. Weitere Informationen hierzu 
finden Sie unter „Volume-Berechtigungen“ 
auf Seite 286.
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Importieren von Video in 
Pro Tools mit Drag & Drop
Sie können Videodateien per Drag & Drop aus 
einem Workspace-Browser oder dem Windows-
Explorer bzw. Mac Finder in die Timeline, eine 
Spur, eine Tracks-Liste oder die Clipliste ziehen.

Wenn Sie diese Methode zum Importieren von 
Video in Pro Tools verwenden, wird das Video 
Import Options-Dialogfeld angezeigt. Dieses 
Dialogfeld enthält verschiedene Optionen zur 
Anpassung der Vorgehensweise beim Importieren 
von Dateien. 

So importieren Sie Videos per Drag & Drop in 
Pro Tools:

1 Ziehen Sie eine oder mehrere Videodateien aus 
einem Workspace-Browser oder dem Windows-
Explorer bzw. Mac Finder in die Tracks-Liste, 
Timeline oder eine bestehende Videospur.

2 Nehmen Sie im Video Import Options-
Dialogfeld die gewünschte Konfiguration vor 
und klicken Sie auf „OK“, um das 
Videomaterial in Pro Tools zu importieren.

Importieren von Video in 
Pro Tools mithilfe des Import 
Session Data-Befehls
Sie können den Import Session Data-Befehl 
benutzen, um Video aus anderen Pro Tools-
Sessions oder aus einer AAF- oder OMF-Sequenz 
zu importieren. Sämtliche Videodateien, die Sie 
importieren, müssen über dieselbe Framerate 
verfügen wie die anderen, bereits in der Session 
vorhandenen Videodateien.

Ziehen von Videodateien aus 
der Clipliste in die Timeline
(Nur Pro Tools HD)

Sie können Videodateien der Timeline einer 
Videospur per Drag & Drop direkt aus der 
Clipliste hinzufügen.

So fügen Sie einer Videospur Videodateien durch 
Ziehen aus der Clipliste hinzu:

1 Wählen Sie in der Clipliste eine oder mehrere 
Videodateien aus.

2 Ziehen Sie in einem beliebigen Edit-Modus die 
ausgewählten Videodateien in einen freien 
Bereich der Timeline (um eine neue Videospur 
zu erstellen) oder in eine bestehende Videospur 
(um die Datei in der Spur zu platzieren).

Weitere Informationen hierzu finden Sie 
unter „Konfigurieren von Optionen für den 
Video-Import“ auf Seite 1275.

Weitere Informationen hierzu finden Sie 
unter „Konfigurieren von Optionen für den 
Video-Import“ auf Seite 1275.

Weitere Informationen zum Importieren von 
Sitzungsdaten finden Sie unter „Importieren 
von Session-Daten“ auf Seite 346.
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Konfigurieren von Optionen 
für den Video-Import
Wenn Sie Videodaten mit Hilfe des Import Video-
Befehls oder durch Ziehen von Videodateien aus 
einem Workspace-Browser oder dem Windows-
Explorer bzw. Mac Finder in Pro Tools importieren, 
wird das Video Import Options-Dialogfeld 
angezeigt.

Destination-Sektion
Im Destination-Abschnitt des Video Import 
Options-Dialogfelds können Sie einen 
allgemeinen Zielort für importierte Videos in 
Pro Tools festlegen.

Haupt-Videospur – die Videodatei wird direkt in 
die Spur, die aktuell online ist (die sogenannte 
Haupt-Videospur) und in die Clipliste importiert. 
Ist aktuell keine Spur online, wird die Videodatei 
in die Videospur importiert, die zuletzt online war.

New Track – jede Videodatei wird in eine eigene 
Spur und in die Clipliste importiert.

Clip List (Nur Pro Tools HD) – jede Videodatei 
wird direkt in die Clipliste importiert, wo Sie für 
Drag & Drop-Vorgänge in die Timeline zur 
Verfügung steht.

Location-Popup-Menü
Wenn Sie im Destination-Abschnitt nicht die 
Clipliste als Zielort auswählen, können Sie im 
Location-Popup-Menü genau auswählen, an 
welcher Stelle der Timeline Pro Tools importierte 
Videos platzieren soll.

Session Start – platziert die Videodatei am Start 
der Session.

Song Start – platziert die Videodatei an der 
Startposition des Songs.

Selection – platziert die Videodatei an der Position 
des Edit-Cursors oder innerhalb der Selektion 
(sofern eine durchgeführt wurde).

Spot – zeigt das Spot-Dialogfeld an, über das Sie 
Videodateien an präzisen Positionen, basierend 
auf einer der Zeitskalen, platzieren können.

Original Time Stamp (nur Avid Video) – platziert 
ein Avid-Video in der Timeline an einer Timecode-
Position, die den Zeitstempeln des ursprünglichen 
Quellbands entspricht. Bei mehreren Videodateien 
werden mit dieser Option alle Videodateien in der 
Timeline an ihren jeweiligen ursprünglichen 
Zeitstempeln positioniert.

Video Import Options-Dialogfeld

Informationen zur Umgehung des Video 
Import Options-Dialogfelds beim Drag & 
Drop von Videodateien finden Sie unter 
„Umgehen des Video Import Options-
Dialogfelds“ auf Seite 1276.
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Weitere Optionen für den 
Videoimport
Gaps Between Clips (Nur Pro Tools HD)  – wenn 
Sie mehr als eine Videodatei in eine Spur 
importieren, werden diese standardmäßig 
miteinander gemischt. Mit dieser Option können 
Sie die Anzahl der Sekunden anzeigen, um die 
Videoclips beim Importieren in die Videospur 
getrennt werden.

Import Audio from File (nur QuickTime-Videos) – 
wenn diese Option ausgewählt ist, werden die 
Audiodaten aus der QuickTime-Videodatei, die 
Sie importieren, extrahiert und in neuen Mono- 
oder Stereo-Audiospuren in der Timeline platziert. 
(Es werden Mono- oder Stereo-Audiodateien mit 
einer Samplerate von 48 kHz oder niedriger 
unterstützt.) Ist die Option nicht aktiviert, wird nur 
das Bild der Videodatei in Pro Tools importiert.

Remove Existing Video Tracks – wenn Sie diese 
Option auswählen, werden alle bestehenden 
Videospuren gelöscht, bevor Pro Tools 
Videodaten in die Session importiert.

Remove Existing Video Clips – wählen Sie diese 
Option aus, um alle bestehenden Videoclips aus 
der Timeline und der Clipliste zu entfernen, bevor 
Pro Tools Videodaten in die Session importiert 
(die Clips verbleiben dabei auf der Festplatte). 
Diese Option ist hilfreich, wenn Sie eine 
Videodatei in die Session importieren möchten, 
deren Framerate nicht mit der aktuellen Video-
Engine-Rate übereinstimmt. 

Clear Main Video Track Playlist – wenn diese 
Option ausgewählt ist, werden alle bestehenden 
Videoclips in der aktuell ausgewählten Playlist auf 
der Haupt-Videospur aus der Spur entfernt, bevor 
Pro Tools Videos in die Session importiert. 
Andere Playlists, Videospuren oder Videoclips 
sind davon nicht betroffen. (Diese Option ist nur 
aktiviert, wenn die Haupt-Videospur als Zielort 
ausgewählt wurde.)

Umgehen des Video Import 
Options-Dialogfelds
Sie können das Video Import Options-Dialogfeld 
bei Drag & Drop-Vorgängen beim Import von 
Videodateien in Pro Tools umgehen. Die 
Videodateien werden exakt an der Position, an der 
Sie sie in der Timeline gemäß dem aktuellen 
Pro Tools-Edit-Modus ablegen, eingefügt.

So umgehen Sie das Video Import Options-
Dialogfeld beim Importieren von Videodateien in 
Pro Tools:

 Halten Sie die Alt- (Windows) oder Wahltaste 
(Mac) gedrückt und ziehen Sie eine oder 
mehrere Videodateien aus einem Workspace-
Browser, dem Windows-Explorer oder Mac 
Finder in die Clipliste oder die Timeline.

Weitere Hinweise finden Sie unter „Video-
Engine-Rate“ auf Seite 1272.
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Importieren von Audio aus 
einem QuickTime-Videoclip
In Pro Tools können Sie per Rechtsklick auf 
ausgewählte Clips Audio aus QuickTime-Movies 
importieren, auch wenn das QuickTime-Video 
zunächst ohne die zugehörigen Audiospur 
importiert wurde.

So importieren Sie Audio aus einem QuickTime-
Videoclip:

1 Klicken Sie mit der rechten Maustaste auf einen 
QuickTime-Videoclip in einer Videospur oder 
in der Clipliste.

2 Wählen Sie Import Audio From Movie.

3 Geben Sie im angezeigten Dialogfeld den 
Speicherort für das Audio an und klicken Sie 
auf Open.

4 Wählen Sie im „Audio Import Options“-
Dialogfeld, ob Sie Audio in die Clipliste oder in 
eine neue Spur importieren möchten.

5 Wenn Sie New Track ausgewählt haben, wählen 
Sie die Position für das Audio:

• Session Start 

• Song Start 

• Selection 

• Spot 

6 Klicken Sie auf OK, um das Audio zu 
importieren (oder auf Cancel, um den Import 
abzubrechen).

Samplerate-Konvertierungs-
Qualität 
Wenn Sie QuickTime-Audiodaten importieren, 
die ursprünglich nicht mit der für Ihre Session 
gewählten Samplerate aufgenommen wurden, 
werden sie automatisch auf die Samplerate Ihrer 
Session konvertiert. In Pro Tools können Sie die 
Qualität der Konvertierung in den Processing-
Voreinstellungen mithilfe der Conversion Quality-
Einstellung bestimmen. 

Es stehen fünf mögliche Einstellungen zur 
Verfügung, die von Low (niedrigste Qualität) bis 
Tweak Head (höchste Qualität) reichen. Je höher 
die gewählte Konvertierungsqualität der 
Samplerate ist, desto länger dauert die 
Konvertierung der Bounce-Datei.

So stellen Sie die Konvertierungsqualität für die 
Samplerate ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf die Processing-Registerkarte.

2 Wählen Sie im Conversion Quality-Popup-
Menü eine Einstellung.
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Videoclips
Sie können Videoclips erstellen, die etwa auf 
dieselbe Weise funktionieren wie Audioclips. 

Eine Videoclip ist ein Segment von Videodaten. 
Er kann aus einem Teilstück eines Videos oder 
einer vollständigen Videodatei bestehen. 
Videoclips in Pro Tools werden aus QuickTime- 
oder Avid-Videodateien erzeugt und können in 
den Playlists entsprechender Videospuren 
angeordnet werden. Videoclips lassen sich auch 
gruppieren, loopen und farblich kodieren.

Wenn Sie Pro Tools HD verwenden, können Sie 
Videoclips auf dieselbe Art hinzufügen, bearbeiten 
und die Darstellungsoptionen ändern, wie dies bei 
Audioclips der Fall ist. Sämtliche Änderungen an 
Videoclips sind nicht destruktiv. (Weitere 
Informationen hierzu finden Sie unter „Allgemeines 
zur Videobearbeitung“ auf Seite 1279.)

Genau wie Audioclips werden auch Videoclips in 
Pro Tools in der Clipliste oder der Timeline 
angezeigt (siehe „Videoclips in der Clipliste“ auf 
Seite 1278).

Wenn Sie Pro Tools verwenden, gelten die 
folgenden Einschränkungen für Videoclips:

• Sie können einer Session nur einen Videoclip 
hinzufügen. Sie kann wiedergegeben, aber nicht 
bearbeitet werden und wird nicht in der Clipliste 
aufgeführt.

• Wenn Sie Video importieren oder eine Session 
öffnen, die mit Pro Tools HD erstellt wurde, 
wird nur die Hauptspur oder die erste verfügbare 
Videospur, die QuickTime-Clips enthält, 
importiert. Sie können mehrere Clips 
wiedergeben und anzeigen und durch die 
Clipgrenzen blättern. Sie können sie allerdings 
nicht bearbeiten.

Videoclips in der Clipliste
(Nur Pro Tools HD)

Ein Videoclip wird in der Clipliste mit einem 
kleinen Videosymbol neben dem Namen 
angezeigt.

Videoclip in der Framedarstellung der Timeline

Videoclip-Symbol in der Clipliste

Weitere Informationen finden Sie unter 
Kapitel 15: „Clipliste“.
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Ein- oder Ausblenden von 
Videoclips in der Clipliste
Im Clip List-Menü stehen Befehle zum Ein- oder 
Ausblenden von Videoclips in der Clipliste zur 
Verfügung.

So blenden Sie Videoclips in der Clipliste ein 
oder aus:

1 Klicken Sie im Edit-Fenster auf das Clip List-
Menü und wählen Sie Show.

2 Wählen Sie die Video-Option, um Videoclips 
ein- oder auszublenden.

Allgemeines zur 
Videobearbeitung
(Nur Pro Tools HD)

Die meisten Bearbeitungsvorgänge, die für 
Audioclips zur Verfügung stehen, können auch 
auf Videoclips angewandt werden. In diesem 
Abschnitt werden alle verfügbaren Vorgänge zur 
Videobearbeitung beschrieben. Sofern nicht anders 
vermerkt, ist die Vorgehensweise beim jeweiligen 
Bearbeitungsvorgang mit der entsprechenden 
Methode bei der Audiobearbeitung identisch.

Grundlegende Videobearbeitungsfunktionen

• nichtdestruktives Editieren

• Anzeigen der Clipnamen und zeitlichen Position 
von Clips sowie anderer Daten in Playlists

• Mehrere Video-Playlists

• Rückgängigmachen mehrerer Vorgänge

• Videoclips und Videoclipgruppen in der Clipliste

• alle Edit-Modi

• alle Edit-Tools (außer dem Time Compression 
Expansion- und Pencil-Tool)

Wiedergeben und Selektieren von 
Videospurmaterial

• Selektieren von Videos mit Frame-Grenzen 
(siehe „Selektieren innerhalb der Videobild-
Grenzen“ auf Seite 1281)

• Selektieren und Bearbeiten über mehrere Spuren 
hinweg (siehe „Selektieren und Editieren über 
mehrere Audio- und Videospuren hinweg“ auf 
Seite 1280)

• Koppeln und Entkoppeln von Spur- und Edit-
Selektionen

• automatisches Scrollen von Videospuren

• Loop-Wiedergabe

• Video Universe-Fenster (siehe „Durchsuchen 
von Videodaten im Video Universe-Fenster“ auf 
Seite 1284)

Arbeiten mit Clips und Selektionen

• Erfassen von Clips

• Trennen von Clips und das Separate Grabber-
Tool

• Überlappen und Verdecken von Clips

• sämtliche Zuschneide-Befehle außer TCE

• Zusammenfügen von separierten Clips

• Platzieren, Ausrichten, Verschieben, Mischen 
und Positionieren von Clips

• Verschieben mit der Nudge-Funktion 
(quantisiert an Frame-Grenzen)

• Shift-Befehl (Verschieben von Material auf einer 
Spur um einen bestimmten Wert nach vorne 
oder hinten)

• Quantize Clip to Grid (Rundung auf 
nächstgelegenes Videobild)

• Replace Clip-Befehl

• Cut-, Copy-, Paste- und Clear-Befehle

Weitere Informationen zu Editiervorgängen 
finden Sie in den entsprechenden Abschnitten 
in diesem Handbuch.
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• Spezielle Befehle zum Ausschneiden, Kopieren, 
Einfügen und Löschen

• Repeat to Fill Selection-Befehl

• Editieren über mehrere Spuren hinweg

• Duplicate-Befehl

• Repeat-Befehl

• Clipgruppen (siehe „Videoclipgruppen“ auf 
Seite 1282)

• Loopen von Clips

Verwalten von Clips

• Einfügen leerer Passagen (siehe „Verwenden 
des Insert Silence-Befehls zum Einfügen von 
leeren Passagen in Videospuren“ auf Seite 1281)

• Compact Selected (die Videodaten bleiben 
unverändert; es muss mindestens eine 
Audiospur ausgewählt sein)

• alle Befehle zur Benennung und Anzeige 
von Clips

Allgemeine 
Bearbeitungsvorgänge, die 
nicht für Videoclips genutzt 
werden können
Die folgenden Bearbeitungsvorgänge können für 
Audioclips, nicht jedoch für Videoclips genutzt 
werden:

• Fades

• Clip stummschalten/Stummschaltung aufheben

• AudioSuite-Plug-Ins

• Reparieren von Wellenformen mit dem Pencil-
Tool

• Strip Silence

• Konsolidieren von Clips

Selektieren und Editieren über 
mehrere Audio- und 
Videospuren hinweg
Sie können eine Selektion über mehrere Audio- 
und Videospuren hinweg vornehmen und Audio- 
und Videodaten gleichzeitig ausschneiden, 
kopieren oder einfügen.

Audio- und Videoinhalte, die selektiert und 
ausgeschnitten, kopiert oder eingefügt werden, 
übernehmen den aktuellen Edit-Modus.

Selektieren und Editieren über mehrere Spuren 
hinweg (Slip-Modus)



Kapitel 52: Video in Pro Tools 1281

Selektieren innerhalb der 
Videobild-Grenzen
Sie können mit Pro Tools keinen Teil eines 
Videobilds auswählen, wiedergeben oder 
bearbeiten. Die folgenden Regeln gelten beim 
Auswählen oder Bearbeiten von Video:

• Wenn Sie eine Selektion in einer Videospur 
vornehmen, folgen die Grenzen der Selektion 
der aktuellen Rastereinstellung, werden aber wie 
folgt auf die nächste Videobild-Grenze 
gerundet:

• Wenn die Auswahl mehr als die Hälfte eines 
Videobilds enthält, wird das volle Videobild 
in die Auswahl aufgenommen.

• Wenn die Auswahl weniger als die Hälfte 
eines Videobilds enthält, wird das Videobild 
nicht in die Auswahl aufgenommen.

• Wenn Sie eine Selektion, die Videodaten 
enthält, in einer Videospur einfügen, wird 
der Einfügungspunkt automatisch an der 
nächstgelegenen Videobild-Grenze ausgerichtet.

Verwenden des Insert Silence-
Befehls zum Einfügen von leeren 
Passagen in Videospuren
Mit dem Insert Silence-Befehl können Sie eine 
Selektion auf einer (oder mehreren) Spuren 
vornehmen und eine leere Passage von genau 
dieser Dauer an beliebiger Stelle einfügen. 
Sie können eine Video- und Audiospuren 
übergreifende Selektion vornehmen und den 
Insert Silence-Befehl nutzen, um stille und leere 
Passagen gleichzeitig einzufügen.

Wenn Sie im Shuffle-Modus arbeiten, werden 
sämtliche Videodaten auf der Spur entsprechend 
der Selektion nach hinten verschoben. Im Slip-, 
Grid- oder Spot-Modus funktioniert der Insert 

Silence-Befehl genauso wie der Edit > Clear-
Befehl.

So fügen Sie leere Passagen in eine Videospur ein:

1 Nehmen Sie in einer Spur oder in Spuren eine 
Selektion vor. Die Länge dieser Selektion 
bestimmt die Länge der eingefügten leeren 
Passage.

2 Wählen Sie Edit > Insert Silence.

Umbenennen von Dateien auf 
der Videofestplatte
Beim Umbenennen von Audioclips in der 
Timeline oder der Clipliste haben Sie die Option, 
auch die Audiodateien auf der Festplatte 
umzubenennen. Dies gilt allerdings nicht für 
Videodateien auf Festplatten.

Um Videodateien auf Festplatten umzubenennen, 
müssen Sie die Umbenennung in einem 
Workspace-Browser oder im Windows-Explorer 
bzw. Mac Finder vornehmen.

Wenn Sie Audio und Video gleichzeitig 
einfügen, kann diese erneute Ausrichtung 
von Videobildern dazu führen, dass die 
Audioinhalte nicht exakt dort positioniert 
werden, wo Sie sie platziert haben. In diesem 
Fall wird ein Warnungsdialogfeld angezeigt.

Änderungen, die über das Betriebssystem 
vorgenommen wurden, werden nicht 
automatisch im Workspace-Browser 
aktualisiert.
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Videoclipgruppen
(Nur Pro Tools HD)

Sie können Videoclips für die folgenden 
Operationen in Clipgruppen zusammenfassen:

• Erstellen von Clipgruppen

• Erstellen von Clipgruppen mit mehreren Spuren 
(einschließlich Audiospuren)

• Editieren von Clipgruppen

• Erstellen von Fades und Crossfades für 
Audiodateien in Clipgruppen

• Importieren und Exportieren von Clipgruppen-
Dateien

Verwenden des 
Videofensters
Im Videofenster von Pro Tools können Sie Videos 
anzeigen oder scrubben.

Sie haben folgende Möglichkeiten, das 
Videofenster anzuzeigen:

 Wählen Sie Window > Video.

 Drücken Sie Strg + 9 (Windows) oder 
Befehl + 9 (Mac).

Ändern der Videofenstergröße
Sie können die Größe des Videofensters durch 
Ziehen oder über das Videofenster-Popup-Menü 
ändern.

So ziehen Sie das Videofenster auf eine neue 
Größe:

 Platzieren Sie den Cursor an einer Ecke des 
Videofensters und ziehen Sie das Fenster auf 
die gewünschte Größe.

Weitere Informationen zur Arbeit mit 
Clipgruppen finden Sie unter „Clipgruppen“ 
auf Seite 877.

Avid-Videoinhalte werden im Videofenster 
nur beim Scrubbing oder Shuttling angezeigt.

Videofenster
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So ändern Sie die Größe des Videofensters über 
das Popup-Menü des Videofensters:

 Klicken Sie mit der rechten Maustaste 
(Windows oder Mac) oder bei gedrückter Ctrl-
Taste (Mac) auf das Videofenster und wählen 
Sie eine der folgenden Optionen zur 
Größenänderung:

• Viertel Größe

• Halbe Größe

• Effektive Größe

• Doppelte Größe

• Vollbildschirm

• Seitenverhältnis.

Scrubben der Videospur
Pro Tools ermöglicht Scrubben von Videos direkt 
auf der Videospur. Scrubben auf Videospuren 
wirkt sich nur auf das Bild aus (keine 
Audiowiedergabe). Das Scrubben des Videos wird 
im Video-Fenster angezeigt. Bei angeschlossener 
externer Hardware lässt sich auswählen, ob das 
gescrubbte Video auf dem externen Monitor oder 
im Video-Fenster angezeigt werden soll.

Beim Scrubben von Audio in einer Videospur 
laufen Audio und Video synchron.

So scrubben Sie eine Videospur:

1 Aktivieren Sie das Scrubber-Tool.

2 Klicken Sie auf die Videospur und ziehen Sie 
den Scrubber.

Shuttling der Videospur
Im Shuttle Lock-Modus können Sie mithilfe des 
Ziffernblocks eine Videospur oder eine oder zwei 
Audiospuren mit einer festgelegten 
Geschwindigkeit vorwärts oder rückwärts 
wiedergeben. Die Zahlen 0 bis 9 stehen dabei für 
die Geschwindigkeit:

• Um das Shuttling zu stoppen, drücken Sie die 0.

• Um die Geschwindigkeit progressiv bis zur 
Normalgeschwindigkeit zu steigern, drücken 
Sie die Zahlen 1 bis 4.

• Für ein Shuttling bei Normalgeschwindigkeit 
drücken Sie die 5.

• Um die Geschwindigkeit progressiv über die 
Normalgeschwindigkeit hinaus zu steigern, 
drücken Sie die Zahlen 6 bis 9.

Diese Funktion betrifft nur die Haupt-Videospur. 
Wenn Sie mehrere Audiospuren ausgewählt 
haben, betrifft diese Funktion nur die ersten 
beiden.

So geben Sie eine Videospur im Shuttle Lock-
Modus wieder: 

1 Stellen Sie in Pro Tools HD sicher, dass der 
Ziffernblockmodus in den Operation-
Voreinstellungen nicht auf „Shuttle“ gestellt ist 
(siehe „Operation Preferences“ auf Seite 108).

2 Stellen Sie sicher, dass bei der Video Online-
Schaltfläche in der zu scrubbenden Videospur 
der Online-Status (blau) aktiviert ist.

3 Klicken Sie mit dem Selector-Tool auf die 
Stelle in der Audiospur, an der die Wiedergabe 
beginnen soll. Um zwei Spuren im Shuttle-
Modus wiederzugeben, klicken Sie bei 
gedrückter Umschalttaste auf eine zweite 
Audiospur. 

Informationen zum Aktivieren bzw. 
Deaktivieren des Scrubben von Video mit 
Video-Hardware finden Se unter „Enable 
Hardware During Scrub“ auf Seite 1262.

Halten Sie die Befehlstaste gedrückt, wenn 
Sie mit einer höheren Auflösung scrubben 
möchten.
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4 Drücken Sie die Windows-Taste (Windows) 
bzw. die Ctrl-Taste (Mac) und eine Ziffer auf 
dem Ziffernblock: Die Ziffer 9 entspricht der 
höchsten Geschwindigkeit, 5 einer normalen, 
0 stoppt das Shuttling. 

Nach dem Aktivieren des Shuttle Lock-Modus 
erscheinen die Fast Forward- und Rewind-
Schaltflächen im Transport-Fenster markiert. 

5 Drücken Sie weitere Tasten, um die 
Wiedergabegeschwindigkeit zu ändern, oder 
drücken Sie die Plus-Taste (+) bzw. die Minus-
Taste (–), um die Richtung zu ändern (Plus-
Taste für vorwärts, Minus-Taste für rückwärts). 

6 Um die Wiedergabe zu beenden, drücken Sie 
Windows + 0 (Windows) bzw. Ctrl + 0 (Mac). 

Zum Beenden des Shuttle Lock-Modus wählen Sie 
eine der folgenden Methoden: 

 Klicken Sie im Transport-Fenster auf „Stop“. 

 Drücken Sie die Leertaste. 

Durchsuchen von Videodaten 
im Video Universe-Fenster
(Nur Pro Tools HD)

Im Video Universe-Fenster können Sie Videoclips 
auf der Haupt-Videospur anzeigen, 
verkleinern/vergrößern (Zoom), selektieren und 
darin navigieren.

Im Video Universe-Fenster wird das mittlere 
Videobild jedes Videoclips auf der Haupt-
Videospur angezeigt. Videobilder werden 
entsprechend ihrer Reihenfolge in der Timeline 
nacheinander angeordnet; der farbige Streifen 
unter jedem Bild stellt die Farbcodierung für 
diesen Clip dar.

So zeigen Sie das Video Universe-Fenster an:

1 Stellen Sie sicher, dass die Video Online-
Schaltfläche in der Haupt-Videospur auf den 
Online-Status (blau) gesetzt ist.

2 Wählen Sie Window > Video Universe.

Vergrößern und Verkleinern von 
Videobildern

So verändern Sie die Größe von Videobildern im 
Video Universe-Fenster:

 Klicken Sie mit der rechten Maustaste (Windows 
oder Mac) oder bei gedrückter Ctrl-Taste (Mac) 
auf eine beliebige Stelle im Video Universe-
Fenster und wählen Sie Increase oder Decrease.

Auswählen von Zoom-
Auflösungen im Video Universe-
Fenster 
Wenn Sie den Cursor über die obere Hälfte eines 
Videobilds im Video Universe-Fenster bewegen, 
fungiert er als Zoom-Tool. Mit diesem Tool können 
Sie einen oder mehrere Videoclips so vergrößern, 
dass sie das gesamte Edit-Fenster ausfüllen.

Video Universe-Fenster mit repräsentativen 
Videobildern für Videoclips in der Haupt-Videospur

Videobild mit Zoom-Tool
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So verwenden Sie das Video Universe-Fenster 
zum Zoomen von Videoclips im Edit-Fenster:

1 Bewegen Sie den Cursor über die obere Hälfte 
eines beliebigen Videobilds, bis er als Zoom-
Tool angezeigt wird.

2 Sie haben folgende Möglichkeiten:

• Um den Anfang eines Videoclips auf der 
Timeline ganz nach links zu verschieben und 
gleichzeitig die aktuelle Zoom-Auflösung im 
Edit-Fenster beizubehalten, klicken Sie (einmal) 
auf das Videobild des Clips.

• Um einen Videoclip so zu vergrößern, dass er 
das gesamte Edit-Fenster ausfüllt, 
doppelklicken Sie auf das Videobild des Clips.

• Um eine Reihe selektierter Clips so zu 
vergrößern, dass sie das Edit-Fenster ausfüllen, 
ziehen Sie die Videobilder, die für die einzelnen 
Clips stehen.

Selektieren von Bereichen im 
Video Universe-Fenster 
Wenn Sie den Cursor über die untere Hälfte eines 
Videobilds im Video Universe-Fenster bewegen, 
fungiert er als Selector-Tool. Mit diesem Tool 
können Sie Bereiche innerhalb einer oder mehrerer 
Videoclips im Edit-Fenster selektieren.

So verwenden Sie das Video Universe-Fenster 
zum Selektieren von Bereichen in Videoclips im 
Edit-Fenster:

1 Bewegen Sie den Cursor über die untere Hälfte 
eines beliebigen Videobilds, bis er als Selector-
Tool angezeigt wird.

2 Sie haben folgende Möglichkeiten:

• Um den Cursor am Anfang eines Videoclips zu 
platzieren, klicken Sie auf das Videobild, das für 
den Videoclip steht.

• Um einen ganzen Videoclip von Anfang bis 
Ende zu selektieren, doppelklicken Sie auf das 
Videobild des entsprechenden Clips.

• Um einen oder mehrere ganze Clips von Anfang 
bis Ende zu selektieren, ziehen Sie die 
Videobilder der entsprechenden Videoclips.

Gleichzeitiges Selektieren 
von Zoom-Auflösungen und 
Abschnitten im Video Universe-
Fenster 
Wenn Sie im Video Universe-Fenster den Cursor 
über ein Videobild bewegen und gleichzeitig die 
Alt- (Windows) oder Wahltaste (Mac) gedrückt 
halten, wird der Cursor als Selector-Tool 
angezeigt. Mit diesem Tool können Sie 
gleichzeitig zoomen und Bereiche selektieren.

Videobild mit Selector-Tool

Wenn die selektierten Videoclips nicht im 
Edit-Fenster angezeigt werden, wird 
automatisch gescrollt, um den Beginn der 
Auswahl anzuzeigen.
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So verwenden Sie das Video Universe-Fenster 
zum gleichzeitigen Selektieren und Zoomen im 
Edit-Fenster:

1 Bewegen Sie den Cursor über einen beliebigen 
Bereich eines beliebigen Videobilds im Video 
Universe-Fenster, bis er als Selector- oder 
Zoom-Tool angezeigt wird.

2 Um einen Bereich mit Videoclips zu selektieren 
und gleichzeitig auf Vollanzeige im Edit-
Fenster zu zoomen, drücken Sie die Alt- 
(Windows) oder Wahltaste (Mac) und ziehen 
Sie mehrere Videobilder.

Wiedergabe von High-
Definition-Video
Mit Pro Tools können Sie High-Definition (HD)-
Videodateien importieren und wiedergeben.

Einrichten der Timecode-Rate 
der Session für den Import von 
HD-Videos
Wenn Sie Video mit Framerates über 30 fps 
wiedergeben, führt Pro Tools nur dann eine 
ordnungsgemäße Synchronisation durch, wenn 
die Timecode-Rate im Session Setup-Fenster auf 
die Hälfte der Framerate der Videodateien 
festgelegt ist.

Um beispielsweise HD-Videos bei 59,94 fps 
(Bilder pro Sekunde) wiederzugeben, ändern Sie 
die Timecode-Rate der Session auf 29,97 fps.

So legen Sie die Timecode-Rate der Session fest:

1 Wählen Sie Setup > Session.

2 Wählen Sie im Session Setup-Fenster im 
Timecode Rate-Popup-Menü die passende 
Timecode-Rate.

Optimierung der 
Videowiedergabe
Einige Videocodecs liefern eine optimale 
Wiedergabeleistung in Pro Tools, wenn Sample-
Mapping verwendet wird (z. B. DNxHD, Apple 
Pro Res und DV25). Videoclips mit diesen Codecs 
sind in der Pro Tools-Clipliste und in der Timeline 
mit einem Häkchen markiert.

Drücken Sie Strg + 2 (Windows) oder 
Befehl + 2 (Mac), um das Session Setup-
Fenster zu öffnen.

Mit Häkchen markierte optimierte Videoclips

Mit Häkchen markierte optimierte Videoclips in 
der Clipliste
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Auch bei Videocodecs ohne Sample-Mapping 
(z. B. Photo JPEG) ist eine normale Wiedergabe 
möglich, es kann jedoch zum Auslassen von 
Frames kommen. Bei diesen Codecs kann die 
Wiedergabeleistung nicht garantiert werden. 
Videos mit diesen Codecs sind auf Videospuren 
und in der Clipliste nicht mit dem Symbol für 
optimierte Videoclips (Häkchen) versehen.

So blenden Sie das Optimized Video Clip-Symbol 
ein oder aus:

 Aktivieren bzw. deaktivieren Sie View > Clip > 

Processing State.

 Aktivieren bzw. deaktivieren Sie über das 
Cliplisten-Menü Show > Processing State.

Tipps zur Optimierung der 
Videowiedergabe
Wenn Sie Pro Tools für die Wiedergabe von 
Videodateien verwenden, hängt die 
Wiedergabequalität von den folgenden 
Faktoren ab:

• Qualität der zur Wiedergabe digitalisierter 
Videoinhalte verwendeten Videohardware 
(Grafikkarte)

• Geschwindigkeit Ihres Computers und der 
Festplatte

• Größe der Videodatei (in Pixel)

• Codec und verwendete Kompressionsstufe

Hier einige Vorschläge für eine bessere und 
flüssigere Wiedergabe eines Videos:

• Verwenden Sie einen unterstützten optimierten 
CODEC wie z. B. DNxHD. (Eine Liste der 
unterstützten Video-Codecs finden Sie auf 
www.avid.com.)

• Komprimieren Sie Video auf eine 
Standardauflösung (wie z. B. 1920 x 1080). 
Stellen Sie sicher, das die verwendete Auflösung 
vom Video-Codec unterstützt wird.

• Wählen Sie einen Projekttyp aus, der auf die 
Video-Framerate und die Auflösung 
zugeschnitten ist. 

• Verwenden Sie einen möglichst schnellen 
Computer und eine schnelle Grafikkarte.

• Verwenden Sie Avid-Videoperipherie.

• Setzen Sie die Scrolling-Option auf „None“ 
(Options > Scrolling > None).

• Verwenden Sie bei Video-Codecs, die kein 
Sample-Mapping nutzen, nur weniger stark 
komprimierte Videoclips (stark komprimierte 
Dateien benötigen mehr Verarbeitungsleistung 
für die Dekomprimierung bei der Wiedergabe).

• Blenden Sie die Videospur aus, wenn Sie sie 
nicht brauchen (oder wechseln Sie von der 
Frames- zur Blockdarstellung). 

• Stellen Sie sicher, dass nicht benötigte Software 
nicht im Hintergrund ausgeführt wird.

• Stellen Sie das Video-Fenster auf die 
tatsächliche Größe ein.

• Versuchen Sie, Leistungseinbrüche oder 
andere Auffälligkeiten durch Deaktivieren 
der GPU in den Pro Tools Operation-
Voreinstellungen zu beheben. In den 
meisten Fällen wird durch Aktivieren 
der GPU die Leistung verbessert. Es gibt 
aber Konfigurationen, bei denen die 
Videoverarbeitung mit der CPU 
zu besseren Ergebnissen führt.

Durch (De)Aktivieren der Processing State-
Option werden die Symbole „Optimized 
Video Clip“ und „Elastic Audio“ ein- bzw. 
ausgeblendet.
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Ausgleichen von 
Verzögerungen beim 
Monitoring von Videos 
Sie können Verzögerungen in der Videoausgabe, 
zu denen es durch externe Decoder und bestimmte 
Anzeigegeräte (etwa Projektoren oder Plasma-
Bildschirme) kommen kann, ausgleichen.

So gleichen Sie Verzögerungen aus, die von 
Videowiedergabegeräten verursacht werden:

1 Wählen Sie Setup > Video Sync Offset.

2 Geben Sie im Set Video Sync Offset-Dialogfeld 
einen Wert im QuickTime Video Offset-Feld 
oder im Windows Media Video Offset-Feld ein, 
mit dem die durch Ihre Videomonitore 
verursachte Verzögerung ausgeglichen 
werden kann.

Ist dieser Wert einmal festgelegt, sollten keine 
Aktualisierungen erforderlich sein, sofern Sie 
nicht Komponenten Ihres Videoanzeigesystems 
(etwa Projektoren oder Plasma-Bildschirme) 
austauschen.

Wiedergabe von Videos auf 
einem externen Monitor über 
Video-Peripheriegeräte
Pro Tools kann mit einem geeigneten Video-
Peripheriegerät Avid- und QuickTime-SD- oder -
HD-Videodateien mit einer framegenauen HD-
Bildausgabe auf diversen professionellen HD-
Monitoren wiedergeben und anzeigen.

HD- oder SD-Ausgabe 
Mit Pro Tools können Sie über von Avid 
qualifizierte Video-Peripheriegeräte Avid- und 
QuickTime-HD- oder -SD-Videos auf einem 
externen HD-SDI-, HDMI-, NTSC- oder PAL-
Monitor ausgeben.

Video Reference
Die Videoausgabe kann auf eine externe 
Videoreferenz eingelockt werden, darunter 
Blackburst und Tri-Level Sync-Signale.

Video Sync Offset-Dialogfeld

Eine Liste der Geräte, die ausdrücklich für 
die Avid- und QuickTime-HD- oder SD-
Wiedergabe mit Pro Tools getestet worden 
sind, finden Sie auf www.avid.com.

Pro Tools HD sollte mit einer geeigneten 
Taktgeber-Referenz gekoppelt sein, 
beispielsweise mit SYNC HD. Falls kein 
externer Audio-Taktgeber angegeben ist, 
wird der Ton nicht am Bild ausgerichtet und 
kann abweichen. 
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Bouncen einer Videospur in 
ein QuickTime-Movie
Wenn Sie die endgültige Mischung fertiggestellt 
und Ihre Audio-Events mit dem Video 
synchronisiert haben, können Sie die 
Hauptvideospur und einen Mono-, Stereo- oder 
Mehrkanal-Downmix (letzteres nur bei Pro Tools 
HD) Ihrer Session in ein neues QuickTime-Movie 
bouncen. Pro Tools HD erlaubt auch das Bouncen 
mehrerer Stems in QuickTime.

Sie können aus einer Reihe von Standard-
QuickTime-Codecs wählen, die voll mit anderen 
QuickTime-Anwendungen kompatibel sind.

So bouncen Sie Video- und Audiodaten in die 
Videospur eines QuickTime-Movies:

1 Stellen Sie Ihre Mischung (oder Stems) fertig.

2 Vergewissern Sie sich, dass die Videospur, 
die Sie bouncen möchten, die Haupt-Videospur 
ist. (Die Video Online-Schaltfläche der Spur 
muss blau markiert sein.)

3 Vergewissern Sie sich, dass alle Audiospuren, 
die Sie bouncen möchten, hörbar (also nicht 
stummgeschaltet oder deaktiviert) sind. 

4 Weisen Sie denselben Stereo-Ausgangs- oder 
Buspfad allen Spurausgängen zu, die im 
Bounce enthalten sein sollen.

5 Sie haben folgende Möglichkeiten:

• Wenn Sie die gesamte Session bouncen 
möchten, klicken Sie im Transport-Fenster auf 
„Return to Zero“, um an den Beginn der Session 
zu gelangen. 

• Wenn Sie jedoch nur einen Abschnitt der 
Session bouncen möchten, aktivieren Sie 
„Options > Link Timeline and Edit Selection“ 
und nehmen Sie im Edit-Fenster oder der 
Timeline eine Selektion vor. 

6 Wählen Sie File > Bounce to > QuickTime 

Movie. Das Bounce to QuickTime-Dialogfeld 
wird geöffnet.

7 Wählen Sie über den Bounce Source-Selektor 
den Masterausgangs- oder Buspfad für Ihre 
Mischung. Sie können auch weitere Bounce-
Quellen hinzufügen (siehe „Gleichzeitiges 
Bouncen mehrerer Quellen“ auf Seite 1143). 

8 Konfigurieren Sie Dateityp, Format, Bitrate und 
Bounce-Optionen je nach Ihren Anforderungen 
(siehe „Bounce-Optionen“ auf Seite 1143).

9 Wählen Sie die Include Video-Option, um die 
Online-Videospur dem Bounce hinzuzufügen.

QuickTime Bounce-Dialogfeld

Alle ausgewählten Quellen im QuickTime-
Bounce werden als Audiospuren von oben 
nach unten in die QuickTime Movie-Datei 
hinzugefügt.
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10 Wählen Sie ggf. „Same as Source“ und 
„Use Avid Codecs“ (siehe „Einstellungen für 
Bounce to QuickTime“ auf Seite 12900).

11 Wenn Sie Avid-Video in QuickTime bouncen 
und die Videoeinstellungen von QuickTime 
konfigurieren möchten, klicken Sie auf 
QuickTime Settings.

12 Aktivieren Sie die Offline-Option, um den 
Bounce schneller als in Echtzeit durchführen zu 
können.

13 Klicken Sie auf Bounce.

14 Wählen Sie einen Zielordner für die neue 
Audiodatei, geben Sie einen Namen ein und 
klicken Sie auf Save.

Einstellungen für Bounce to 
QuickTime
Beim Bouncen in QuickTime sind folgende 
Optionen sind verfügbar:

Include Video

Wählen Sie diese Option, um die Online-
Videospur dem Bounce hinzuzufügen.

Same as Source

Wählen Sie die Option Same As Source, um beim 
Bouncen in QuickTime die Videoauflösung der 
Online-Videospur zu übernehmen. Die Same As 
Source-Option ist bei bestimmten Typen von 
LongGOP-QuickTime-Medien (z. B. XDCAM) 
oder bei Verwendung mehrerer Codecs auf einer 
Spur nicht verfügbar.

Use Avid Codecs

Die Use Avid Codecs-Option ist nur bei 
Verwendung der mit Avid LE (erhältlich unter 
www.avid.com) oder den PE Codec Packs 
(im Pro Tools-Installationsprogramm enthalten) 
installierten Codecs verfügbar. Wählen Sie diese 
Option, wenn sich zwei ähnliche Codecs auf Ihrem 
System befinden. DV25 ist beispielsweise in einer 
Standard-QuickTime-Installation enthalten, wird 
aber auch von Avid in einer für Avid-Produkte 
(z. B. Pro Tools und Media Composer) optimierten 
Version angeboten.

Beim Bouncen eines Avid-Codecs in QuickTime 
muss der Avid-Codec auf allen Wiedergabesystemen 
zur Wiedergabe von QuickTime-Dateien im 
QuickTime Player konfiguriert sein.

Konsultieren Sie die Apple-Dokumentation 
für weitere Informationen zum Konfigurieren 
von Einstellungen für QuickTime-Movies.

Das Bouncen des Videos kann länger dauern 
als die Videodauer in Echtzeit, je nach 
Format des Quellvideos, Format des 
gebouncten Videos und 
Verarbeitungsgeschwindigkeit.
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QuickTime-Einstellungen

In Pro Tools können Sie mit Hilfe der QuickTime 
Settings-Optionen Video in QuickTime 
transkodieren (das Encoder-Plug-In für 
QuickTime muss installiert sein). Wenn Sie in 
QuickTime bouncen und das Video in der Session 
nicht in einer gültigen Videoauflösung oder einem 
Codec für QuickTime vorliegt, werden Sie 
aufgefordert, über die QuickTime Settings das 
Video in eine gültige Auflösung und einen Codec 
für QuickTime zu transkodieren.

So transkodieren Sie Video in eine gültige 
QuickTime-Auflösung:

1 Wählen Sie File > Bounce to > QuickTime.

2 Aktivieren Sie im „QuickTime Bounce“-
Dialogfeld die Include Video-Option.

3 Klicken Sie auf QuickTime Settings. Wenn das 
Video für den Bounce in einer gültigen 
Auflösung und einem Codec für QuickTime 
vorliegt, sind QuickTime Settings ausgegraut.

4 Konfigurieren Sie die Einstelllungen im Movie 
Settings-Dialogfeld wunschgemäß.

5 Klicken Sie auf OK.

6 Konfigurieren Sie die anderen Einstellungen im 
QuickTime Bounce-Dialogfeld wunschgemäß.

7 Klicken Sie auf Bounce.

„QuickTime Bounce“-Dialogfeld, aktivierte 
„Include Video“-Option

„Movie Settings“-Dialogfeld

Beim Bouncen von Pro Tools in QuickTime 
werden die Einstellungen für Sounds im Movie 
Settings-Dialogfeld ignoriert.
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Teil XII: Satellite-Systeme
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Kapitel 53: Satellite Link

Mit der Avid Satellite Link-Option können Sie 
über ein Ethernet-Netzwerk bis zu 
12 Pro Tools HD-Systeme miteinander verbinden. 
Dabei können Sie Positionen anfahren, 
Audiomaterial wiedergeben und den Transport 
anhalten sowie Editing-Selektionen treffen und 
Spuren auf jedem der Systeme über jede beliebige 
angeschlossene Workstation soloschalten. 

Alternativ dazu haben Sie auch die Möglichkeit, 
bis zu elf Pro Tools HD-Systeme und eines der 
folgenden Systeme zu koppeln:

• ein Pro Tools Video Satellite-System, bei dem 
ein separates Pro Tools-System für die 
Videowiedergabe verwendet wird;

• ein Avid Video Satellite-System, bei dem ein 
Avid Media Composer oder Avid Symphony-
System für die Videowiedergabe, -einspielung 
und -wandlung benutzt wird.

Über jedes der verbundenen Pro Tools HD-
Systeme können Sie Netzwerksysteme koppeln 
und entkoppeln, Systemen Namen zuweisen und 
den Kopplungsstatus anderer verbundener 
Systeme anzeigen.

In den Satellite Link-Voreinstellungen können 
Sie verbundene Pro Tools HD-Systeme für 
Workflows mit einem oder mehreren Bedienern 
konfigurieren.

Satellite Link kann gleichzeitig mit Avid 
MachineControl™ genutzt werden, wobei ein 
gekoppeltes Pro Tools HD-System online sein und 
ein 9-Pin-fähiges Gerät steuern kann. 

Bei Systemen mit einer D-Control- oder 
D-Command-Konsole kann Satellite Link mit dem 
ICON-Multi-Modus zusammenarbeiten. Dadurch 
können Sie den Transport für bis zu vier verbundene 
Pro Tools HD-Systeme selektiv über eine einzelne 
D-Control-Konsole steuern, oder bis zu zwei 
Pro Tools HD-Systeme über D-Command. 

Systemanforderungen und 
Kompatibilität für Satellite 
Link

Systemanforderungen für 
Satellite
Je Pro Tools HD-System im Netzwerk ist 
Folgendes erforderlich:

• Von Avid qualifizierter Computer mit 
Pro Tools HD-Software

• Avid HDX- oder HD Native-Hardware

• Avid SYNC HD-Peripheriegerät

• Ethernetanschluss an ein Local Area Network 
(LAN) 

Weitere Informationen dazu finden Sie 
unter Kapitel 54: „Pro Tools Video 
Satellite“ und Kapitel 55: „Avid Video 
Satellite“.

Alle Pro Tools-Systeme in einem Satellite 
Link-Netzwerk müssen über SYNC HD 
auf eine gemeinsame Videoreferenz 
synchronisiert werden.



Pro Tools-Referenzhandbuch1296

Konfigurieren von Satellite 
Link
Um mehrere Pro Tools HD-Systeme in einem 
Satellite Link-Netzwerk zu kombinieren, 
konfigurieren Sie die grundlegenden 
Netzwerkeinstellungen und das Satellite Link-
Netzwerk auf jedem der Pro Tools-Systeme.

Konfigurieren der 
Netzwerkeinstellungen
Satellite Link-Systeme kommunizieren über 
Ethernet-LANs (Local Area Network). Sie können 
die Netzwerkeinstellungen auf jedem der 
Pro Tools-Systeme konfigurieren, um so ein oder 
mehrere Satellite Link-Netzwerke in einem LAN 
einzurichten. 

Satellite Link erfordert, dass die Systeme über 
Ethernet-LAN verbunden sind. Alle Systeme 
sollten sich im selben Subnetz befinden. Falls 
möglich, sollten sie auch mit demselben Ethernet-
Switch verbunden sein, um die Reaktionszeit über 
das Netzwerk so gering wie möglich zu halten. 

Ethernet-Interface

Auf Computern mit mehreren Ethernet-Interfaces 
können sie das Interface für die Kommunikation 
mit Satellite Link auswählen.

So wählen Sie ein Ethernet-Interface für Satellite 
Link aus:

1 Wählen Sie Setup > Peripherals und klicken Sie 
auf Satellites.

2 Wählen Sie unter Advanced Network Settings 
aus dem Interface-Popup-Menü das Ethernet-
Interface. 

3 Klicken Sie auf OK.

TCP/UDP Port

In einem Satellite Link-Netzwerk müssen die 
verbundenen Systeme über denselben TCP/UDP-
Port kommunizieren. Verfügbare Satellite-Systeme 
werden nur auf anderen Satellite-Systemen 
angezeigt, wenn Sie denselben Port nutzen.

Der Standard-TCP/UDP-Port für Satellite Link 
ist 28282. 

Falls der Standard-Port bereits in Verwendung ist 
oder Sie separate Satellite Link-Netzwerke 
einrichten möchten, können Sie einen anderen 
TCP/UDP-Port für die Satellite Link-
Kommunikation benutzen.

So wählen Sie den TCP/UDP-Port für die Satellite 
Link-Kommunikation:

1 Wählen Sie Setup > Peripherals und klicken Sie 
auf Satellites.

2 Geben Sie unter Advanced Network Settings 
die TCP/UDP-Portnummer ein, die Sie 
verwenden möchten. 

3 Klicken Sie auf OK.

Damit Satellite Link ordnungsgemäß 
funktioniert, müssen Sie eine TCP/UDP-
Portnummer zwischen 1024 und 65534 
auswählen.
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Konfigurieren eines Satellite 
Link-Netzwerks
Wenn Sie Pro Tools HD-Systeme für den Satellite 
Link-Betrieb einrichten, muss eines der Pro Tools-
Systeme im Netzwerk als Administrator-System 
festgelegt werden. 

Andere Systeme im Netzwerk werden als Satellite-
Systeme eingerichtet und werden vom 
Administratorsystem aus dem Netzwerk 
hinzugefügt. 

Konfigurieren eines Satellite-Systems

Führen Sie für jedes Pro Tools-System, das Sie als 
Satellite Link-System konfigurieren möchten, 
folgende Schritte aus:

1 Wählen Sie Setup > Peripherals und klicken sie 
auf Satellites.

2 Geben Sie im System Name-Feld den Namen 
des Systems ein.

3 Wählen Sie unter Mode die Satellite-Option.

4 Klicken Sie auf OK.

So konfigurieren Sie ein Media Composer-System 
als Video Satellite:

1 Wählen Sie in Media Composer Edit > 

Preferences.

2 Klicken Sie im Project-Fenster auf die Settings-
Registerkarte und doppelklicken Sie auf Video 

Satellite.

3 Wählen Sie im Video Satellite Settings-Fenster 
die Video Satellite Mode-Option. 

4 Klicken Sie auf OK.

So konfigurieren Sie ein nicht-Pro Tools HD-
System als Video Satellite:

1 Wählen Sie im Pro Tools-System Setup > 
Peripherals und klicken sie auf Satellites.

2 Geben Sie im System Name-Feld den Namen 
des Systems ein.

3 Wählen Sie unter Mode die Enable Satellite 

Mode-Option.

4 Klicken Sie auf OK.

Konfigurieren eines Systems als Satellite auf der 
Satellites-Seite des Peripherals-Dialogfelds

Konfigurieren eines Pro Tools Video Satellite-Systems 
auf der Satellites-Seite des Peripherals-Dialogfelds
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Konfigurieren eines Administrator-
Systems

So konfigurieren Sie ein Pro Tools-System als 
Satellite Link-Administrator:

1 Wählen Sie Setup > Peripherals und klicken sie 
auf Satellites.

2 Geben Sie im System Name-Feld den Namen 
des Systems ein.

3 Wählen Sie unter Mode die Administrator-
Option.

4 Wählen Sie unter Administrator das aktuelle 
System aus dem System 1-Popup-Menü. 

5 Klicken Sie auf OK.

Hinzufügen von Satellites zum 
Netzwerk

Wenn ein System als Satellite konfiguriert wurde, 
ist es im Administratorsystem verfügbar. 
Satellitensysteme können vom 
Administratorsystem aus deklariert werden, 
um das Satellite Link-Netzwerk aufzubauen.

So deklarieren Sie ein Satellite-System:

1 Wählen Sie im Administrator-System Setup > 
Peripherals und klicken sie auf Satellites.

2 Deklarieren Sie unter Administrator die 
gewünschten Systeme über die System 2-12-
Popup-Menüs als Satellites. 

3 Klicken Sie auf OK.

Der Administrator und die deklarierten Satellite-
Systeme erscheinen im Transport- und im Edit-
Fenster im Synchronization-Abschnitt. Die Größe 
der Anzeige wird automatisch angepasst, um alle 
verfügbaren Systeme anzuzeigen.

Konfigurieren des Administrator-Systems auf der 
Satellites-Seite des Peripherals-Dialogfelds

Deklarierte Satellites im Synchronization-Abschnitt 
des Transport-Fensters
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Koppeln von Satellite-
Systemen
Wenn ein Pro Tools-System als Satellite deklariert 
wurde, kann es auf dem lokalen Computer oder 
einem anderen Satellite in den Kopplungszustand 
versetzt werden. Ist ein System gekoppelt, können 
die folgenden Funktionen und Befehle über alle 
gekoppelten Systeme gesteuert werden:

• Koppeln und Entkoppeln des Systems

• Transport-Steuerelemente (Stopp, Wiedergabe, 
schneller Vorlauf, Rücklauf)

• Wiedergabe-Selektionen

• Scrub-/Shuttle-Position

• Kanal-Soloschaltung (einschließlich Solo 
aufheben)

• Behandeln von Systemfehlermeldungen (etwa 
DAE-Fehler)

Satellite Link-Steuerelemente
Wenn ein Pro Tools-System als Satellite deklariert 
wurde, erscheinen die folgenden Satellite Link-
Steuerelemente im Transport- und im Edit-
Fenster: 

Link-Schaltfläche – steuert den Kopplungsstatus 
des lokalen Systems.

Satellite Link-Schaltflächen – steuern den 
Kopplungsstatus der anderen Satellite-Systeme. 
In jedem System entspricht eine dieser 
Schaltflächen der Haupt-Link-Schaltfläche 
des jeweiligen Systems.

Link-Schaltflächen leuchten auf, wenn die 
Kopplung aktiv ist.

So zeigen Sie Satellite Link-Steuerelemente im 
Transport-Fenster an:

 Wählen Sie View > Transport > Synchronization 
und View > Transport > Expanded.

So koppeln Sie das lokale Pro Tools-System bzw. 
heben die Kopplung auf:

 Klicken Sie im Transport-Fenster auf die Link-
Schaltfläche. 

So koppeln Sie andere Satellite-Systeme bzw. 
heben die Kopplung auf:

 Klicken Sie im Transport-Fenster auf die 
entsprechende Satellite Link-Schaltfläche.

So koppeln Sie alle Satellite-Systeme bzw. heben 
die Kopplung auf:

 Halten Sie die Alt-Taste (Windows) bzw. 
Wahlttaste (Mac) gedrückt und klicken Sie im 
Transport-Fenster auf die Satellite Link-
Schaltfläche.

Koppeln während der Wiedergabe

Sie können ein System koppeln oder die Kopplung 
aufheben, während die Wiedergabe auf dem 
System oder einem anderen gekoppelten System 
läuft. Der Transport ist dann synchronisiert. Wenn 
auf beiden Systemen wiedergegeben wird, erhält 
das neu gekoppelte System einen Cue-Befehl von 
der Position des Systems, auf dem die Kopplung 
durchgeführt wurde.

Satellite Link-Steuerelemente im Transport-Fenster

LINK-Taste

Satellite Link-Schaltflächen
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Verknüpfen von Wiedergabe-
Selektionen
Sie können gekoppelte Pro Tools-Systeme so 
einrichten, dass sie Wiedergabe-Selektionen an 
andere Satellite-Systeme übertragen oder von Ihnen 
empfangen. Dadurch können Sie Ihre Systeme so 
konfigurieren, dass Edit-Fenster-Selektionen 
selektiv zwischen Systemen gespiegelt werden oder 
dass alle Edit-Fenster-Selektionen aller Systeme auf 
allen anderen Systemen gespiegelt werden. 

 Wenn Sie in einer Synchronisationsumgebung 
mit mehreren Benutzern arbeiten, in der Dialog, 
Effekte und Musik auf verschiedenen Systemen 
gespeichert sind, kann es sinnvoll sein, die 
Systeme so einzurichten, dass sie Wiedergabe-
Selektionen nur übertragen und das Recording- 
bzw. Video-Pro Tools-System so, dass es 
Wiedergabe-Selektionen nur empfangen kann.

 Wenn Sie in einer Mischumgebung mit einem 
Benutzer arbeiten, der zwischen den Systemen 
wechselt, ist es vielleicht sinnvoll, wenn alle 
Systeme Wiedergabe-Selektionen übertragen und 
empfangen können, damit Sie auf jedem System 
mit der gleichen Selektion arbeiten können.

So richten sie Pro Tools-Systeme zum Spiegeln 
der Wiedergabe-Selektionen auf anderen Satellite-
Systemen ein:

1 Führen Sie auf den Systemen, auf denen die 
Wiedergabe-Selektion erfolgt, folgende 
Schritte aus:

• Wählen Sie Setup > Preferences und klicken 
Sie auf Synchronization. 

• Wählen Sie im Satellites-Abschnitt der 
Synchronization-Registerkarte die Transmit 

Play Selections-Option.

2 Führen Sie auf den Systemen, auf denen die 
Wiedergabe-Selektion gespiegelt werden soll, 
folgende Schritte aus:

• Wählen Sie Setup > Preferences und klicken 
Sie auf Synchronization. 

• Wählen Sie im Satellites-Abschnitt der 
Synchronization-Registerkarte die Receive Play 

Selections-Option.

• Klicken Sie auf OK, um das Preferences-
Fenster zu schließen.

3 Vergewissern Sie sich, dass die Systeme 
gekoppelt sind.

Solo-Koppelung
Sie können gekoppelte Pro Tools-Systeme so 
einrichten, dass Sie den Solostatus Ihrer Spuren an 
andere Satellite-Systeme übertragen oder von 
ihnen empfangen. 

 Wenn Sie in einer Synchronisationsumgebung 
mit mehreren Benutzern arbeiten, in der Dialog, 
Effekte und Musik auf verschiedenen Systemen 
gespeichert sind, kann es sinnvoll sein, die 
Systeme so einzurichten, dass sie den Solostatus 
übertragen und empfangen können und das 
Recording- bzw. Video-Pro Tools-System so, dass 
es das nicht kann. 

 Wenn Sie in einer Mischumgebung mit einem 
Benutzer arbeiten, der zwischen den Systemen 
wechselt, ist es vielleicht sinnvoll, wenn alle 
Systeme den Solostatus übertragen und empfangen 
können, damit Solos auf allen System 
einheitlich sind.

Solo Safe Wenn die Solo-Koppelung aktiviert ist, 
behalten alle Systeme ihren Solo Safe-Status bei.

Solo Clear Wenn die Solo-Koppelung aktiviert ist, 
werden auf einem empfangenden System alle 
Solos zurückgesetzt.
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So richten Sie Satellite-Systeme für Übertragung 
und Empfang des Solostatus ein:

1 Führen Sie auf dem System, das den Solostatus 
übertragen soll, folgende Schritte aus:

• Wählen Sie Setup > Preferences und klicken 
Sie auf Synchronization. 

• Wählen Sie im Satellites-Abschnitt der 
Synchronization-Registerkarte die Transmit 

Solos-Option. 

2 Führen Sie auf den Systemen, die den 
Solostatus übernehmen sollen, folgende 
Schritte aus:

• Wählen Sie Setup > Preferences und klicken 
Sie auf Synchronization. 

• Wählen Sie im Satellites-Abschnitt der 
Synchronization-Registerkarte die Receive 

Solos-Option.

• Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

3 Vergewissern Sie sich, dass die Systeme 
gekoppelt sind.

Verwenden der Solo-Kopplung ohne 
Koppeln der Transport-Steuerelemente

Wenn Sie mehrere Pro Tools-Systeme über ein 
externes Synchronisationsgerät synchronisieren, 
können Sie dennoch die Solo Link-Funktion 
nutzen. 

Sie können ein Pro Tools-System so einrichten, 
dass es unabhängig von der Kopplung seinen 
Solostatus sendet. Dadurch können Sie Spuren 
über die Systeme hinweg soloschalten, ohne die 
Transport-Steuerelemente zu koppeln. 

So richten Sie ein Pro Tools-System zur 
Soloübertragung unabhängig von der Kopplung 
ein:

1 Wählen Sie Setup > Preferences und klicken 
Sie auf Synchronization. 

2 Wählen Sie im Satellites-Abschnitt der 
Synchronization-Registerkarte die Solo 

Independent of Linked State-Option.

3 Klicken Sie auf OK, um das Preferences-Fenster 
zu schließen.

Solo Link-Verhalten in den Solo-Modi

Solo in Place Beim Verwenden von Solo Link mit 
Solo in Place wird der Solo-Betriebsmodus durch 
das System bestimmt, das den Solostatus 
überträgt.

 Wenn sich ein gekoppeltes System im Solo 
Latch-Modus befindet, führt das Soloschalten 
einer Spur auf diesem System dazu, dass die 
Anzahl von Solospuren unabhängig vom 
Solomodus auf den empfangenden Systemen 
erhöht wird.

 Befindet sich ein gekoppeltes System im Solo 
X-OR-Modus, führt das Soloschalten einer Spur 
dazu, dass die Solos aller anderen Systeme 
unabhängig vom Solomodus auf den anderen 
empfangenden Systemen storniert werden.

AFL- und PFL-Modus Beim Verwenden von Solo 
Link haben AFL- und PFL-Solos auf gekoppelten 
Systemen keine Auswirkung auf andere Systeme.

Eine Spur mit AFL-Solo auf einem gekoppelten 
System kann durch ein Solo in Place auf einem 
anderen System stummgeschaltet werden. Um dies 
zu vermeiden, sollten Sie statt AFL PFL 
verwenden.
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Satellite Link-Betrieb 

Behandeln von Fehlermeldungen auf 
gekoppelten Systemen

Standardmäßig wird auf gekoppelten Systemen 
der Betrieb fortgesetzt, wenn bei einem der 
Systeme ein Fehler auftritt und der Transport 
anhält. Fehlermeldungen auf einem gekoppelten 
System werden im Transport-Fenster mittels 
QuickInfo für die jeweilige Satellite Link-
Schaltfläche dargestellt.

Sie können alle Systeme so einrichten, dass die 
Wiedergabe angehalten wird, wenn auf ihnen ein 
Fehler auftritt. 

So behandeln Sie einen Fehlerdialog auf einem 
gekoppelten System:

 Klicken Sie auf einem anderen gekoppelten 
System im Transport-Fenster bei gedrückter 
Umschalt-Taste auf die Satellite Link-
Schaltfläche des vom Fehler betroffenen 
Systems. 

So richten Sie ein gekoppeltes System so ein, 
dass der Transport auf allen Systemen angehalten 
wird, wenn ein Fehler auftritt:

 Vergewissern Sie sich, dass in den 
Synchronization-Voreinstellungen die DAE 

Errors Stop All Linked Systems-Option aktiviert 
ist.

Damit bei einem Fehler auf allen Systemen der 
Transport angehalten wird, muss diese Option auf 
allen gekoppelten Systemen aktiviert sein.

Wiedergabe- und Modaldialoge

Auf gekoppelten Systemen wird die Wiedergabe 
angehalten (oder nicht gestartet), wenn ein 
Modaldialogfeld (z. B. I/O Setup, Hardware Setup 
oder Playback Engine) auf einem der gekoppelten 
Systeme offen ist. 

Verwenden von Satellite Link 
und MachineControl
Der MachineControl-Modus Deck Control Mode 
kann zum Betreiben eines 9-Pin-
Synchronisationgeräts (etwa Soundmaster ATOM 
oder ein CB Electronics 9-Pin-Synchronizer) 
benutzt werden. Dadurch kann Pro Tools als 
„Code-only-Master“ für Systeme fungieren, 
die durch einen Synchronizer gesteuert werden.

Gleichzeitig mit Satellite Link können Sie auf 
einem gekoppelten Pro Tools-System 
MachineControl einsetzen.

 Wenn ein gekoppelten Pro Tools-System 
bereits online ist und Sie mit einem weiteren 
online gehen, wird das erste Satellite Link-System 
automatisch offline gestellt.

 Jedes gekoppelte Pro Tools-System, dessen 
Status „Transport=Pro Tools“ ist, übernimmt die 
Satellite Link-Transportbefehle. 

 Ein gekoppeltes Pro Tools-System, dessen 
Status „Transport=Machine“ ist, kann keine 
Satellite Link-Transportbefehle übermitteln, 
übernimmt aber die Satellite Link-
Transportbefehle, wenn es offline ist. 

Um zu verhindern, dass beim Öffnen eines 
Modaldialogs die Wiedergabe auf anderen 
Systemen unterbrochen werden, heben Sie 
die Systemkopplung vor dem Öffnen des 
Dialogfelds auf.
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Bedienoberfläche für 
Satellite Link

Koppeln von Satellite Link-
Systemen
(D-Control, D-Command und C|24)

So koppeln Sie das lokale Pro Tools-System bzw. 
heben die Kopplung auf:

 Halten Sie die Strg-Taste (Windows) bzw. die 
Befehlstaste (Mac) gedrückt und drücken Sie 
den Machine Online-Schalter im Transport-
Bereich. 

Soft Keys für Satellite Link
(D-Control und D-Command)

So koppeln Sie andere Satellite-Systeme bzw. 
heben die Kopplung auf:

1 Drücken Sie bei gedrückter ctrl-Taste (Mac) 
bzw. Alt-Taste (Windows) den Modes-Schalter 
in der Automation Soft Keys-Sektion.

2 Drücken Sie den Soft Key für den Namen des 
Systems, das Sie koppeln bzw. entkoppeln 
möchten. 

Der Soft Key leuchtet, um anzuzeigen, dass das 
betroffene System gekoppelt ist, und blinkt, wenn 
auf dem System ein Fehler angezeigt wird. 

So koppeln Sie alle Satellite-Systeme bzw. heben 
die Kopplung auf:

 Halten Sie die Alt-Taste (Windows) bzw. 
die Wahl- und die Befehlstaste (Mac) gedrückt 
und drücken Sie den Online-Schalter im 
Transport-Bereich.

So schalten Sie den Solo-Übertragungsstatus des 
lokalen Pro Tools-Systems um:

1 Drücken Sie bei gedrückter ctrl-Taste (Mac) 
bzw. Alt-Taste (Windows) den Modes-Schalter 
in der Automation Soft Keys-Sektion.

2 Drücken Sie den Soft Key für „Solo übertragen“.

Der Soft Key leuchtet, um anzuzeigen, dass die 
Soloübertragung aktiviert ist.

Satellite Link und EUCON 
Control
Eine Reihe von Steuerelementen für Satellite Link 
wurde für EUCON angepasst. Weitere 
Informationen zur Steuerung von Satellite Link-
Funktionen mit EUCON-Geräten finden Sie im 
Pro Tools-EUCON-Handbuch.
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Kapitel 54: Pro Tools Video Satellite

Pro Tools Video Satellite ist eine leistungsstarke 
Postproduktionsoption, wobei ein separater 
Computer zum Einsatz kommt, auf dem 
Pro Tools-Software zur synchronisierten 
Videowiedergabe läuft. 

Durch die Auslagerung von Wiedergabeaufgaben 
auf einen separaten Computer trägt Pro Tools 
Video Satellite zur bestmöglichen Leistung des 
Pro Tools-Administratorsystems bei.

Pro Tools Video Satellite verwendet ein einzelnes 
Nicht-HD-Pro Tools-System für die 
Videowiedergabe in einer Satellite-Konfiguration. 
Pro Tools Video Satellite erfordert Pro Tools-
Software (aber keine Pro Tools HD-Software) und 
verwendet jedes von Avid unterstützte Nicht-HD-
Audio-Interface (wie Mbox Pro). Ein Pro Tools 
Video Satellite kann keine Video-Referenz 
verwenden, daher ist es nicht so genau wie ein 
Avid Video Satellite. 

Systemanforderungen für 
Pro Tools Video Satellite
• Von Avid qualifizierter Computer

• Avid Pro Tools-Software

• Unterstütztes Videoperipheriegerät (optional)

• Client-Monitor (optional)

• Black Burst- oder TriLevel-Video-
Referenzgenerator bei Verwendung eines 
Videoperipheriegeräts 

• Ethernetanschluss an ein Local Area Network 
(LAN)

Optionen für die 
Videoausgabe
Mit Pro Tools Video Satellite können Sie Video 
über ein Peripheriegerät von Avid oder einem 
anderen Anbieter ausgeben.

• Wiedergabe auf einem externen Monitor mit 
Avid Nitris DX Ausgabeformate sind unter 
anderem HD/SD-SDI, HDMI und HD/SD 
Analog.

• Wiedergabe auf einem externen Monitor mit 
Avid Mojo DX Ausgabeformate sind unter 
anderem HD/SD-SDI und HDMI.

• Vollbildwiedergabe auf dem primären 
oder sekundären Computermonitor über den 
DVI-Ausgang

• Wiedergabe auf einem externen Monitor mit 
unterstützter Videohardware von Drittanbietern
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Verbinden von Pro Tools 
Video Satellite
Um das Pro Tools Video Satellite-System mit dem 
Pro Tools-Administratorsystem zu verbinden, 
muss dieses System als Administratorsystem 
festgelegt werden. 

Das Pro Tools Video Satellite-System ist als 
Satellite-System konfiguriert und wird dann im 
Administratorsystem deklariert.

Konfigurieren eines Pro Tools-
Hauptsystems als 
Administrator:

So konfigurieren Sie das Pro Tools-Hauptsystem 
als Administrator:

 Siehe „Konfigurieren eines Administrator-
Systems“ auf Seite 1298.

Konfigurieren eines Pro Tools 
Video Satellite-Systems

So konfigurieren Sie das Pro Tools Video Satellite-
System:

 Siehe „Konfigurieren eines Satellite-Systems“ 
auf Seite 1297.

Definieren eines Pro Tools Video 
Satellite-Systems
Wenn ein Pro Tools Video Satellite-System als 
Satellite konfiguriert wurde, ist es im 
Administratorsystem verfügbar. Das Satellite-
System wird dann vom Administrator deklariert.

So deklarieren Sie das Satellite-System im 
Administratorsystem:

 Siehe „Hinzufügen von Satellites zum 
Netzwerk“ auf Seite 1298.

Die Systeme werden von links nach rechts im 
Synchronization-Abschnitt des Transport-Fensters 
angezeigt.

Koppeln eines Pro Tools 
Video Satellite-Systems
Wenn ein Pro Tools-System als Satellite 
verbunden wurde, kann es in den 
Kopplungszustand versetzt werden. Wenn das 
System gekoppelt ist, folgt es den 
Transportbefehlen aus dem Administratorsystem 
und läuft synchron damit. Wenn das Satellite-
System nicht gekoppelt ist, verhält sich der 
Transport wie bei einem normalen Pro Tools-
System.

Vollständige Anweisungen zum Konfigurieren 
eines Satellite Link-Netzwerks mit einem 
Pro Tools Video Satellite-System finden Sie 
unter „Konfigurieren von Satellite Link“ auf 
Seite 1296. Nur ein Pro Tools Video Satellite-System 

kann mit einem Satellite Link-Netzwerk 
verbunden sein.

Das Pro Tools-Administratorsystem reagiert 
nicht auf Wiedergabebefehle aus dem 
Pro Tools Video Satellite-System. 
Transportbefehle müssen aus dem Pro Tools-
Hauptsystem kommen.
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Link-Steuerelemente
Wenn ein Pro Tools-System als Satellite deklariert 
wurde, erscheinen die folgenden Steuerelemente 
im Transport-Fenster: 

Link-Schaltfläche – steuert den Kopplungsstatus 
des lokalen Systems.

Satellite Link-Schaltflächen – steuern den 
Kopplungsstatus der anderen Satellite-Systeme. 
In jedem System entspricht eine dieser 
Schaltflächen der Haupt-Link-Schaltfläche des 
jeweiligen Systems.

Link-Schaltflächen leuchten auf, wenn die 
Kopplung aktiv ist.

So zeigen Sie Link-Steuerelemente im Transport-
Fenster an:

 Wählen Sie View > Transport > 
Synchronization und View > Transport > 
Expanded.

So koppeln Sie das lokale Pro Tools 
Video Satellite-System bzw. heben die Kopplung 
auf:

 Klicken Sie im Transport-Fenster auf die Link-
Schaltfläche. 

So koppeln Sie das Pro Tools-
Administratorsystem oder andere Satellite-
Systeme bzw. heben die Kopplung auf:

 Klicken Sie im Transport-Fenster auf die 
entsprechende Satellite Link-Schaltfläche.

So koppeln Sie alle deklarierten Satellite-Systeme 
bzw. heben die Kopplung auf:

 Halten Sie die Alt-Taste (Windows) bzw. 
Wahlttaste (Mac) gedrückt und klicken Sie auf die 
Link-Schaltfläche oder eine der Satellite Link-
Schaltflächen im Transport-Fenster.

Koppeln während der Wiedergabe

Während die Wiedergabe auf dem Pro Tools HD-
Administratorsystem läuft, können Sie das 
Pro Tools Video Satellite-System koppeln und die 
Transporte werden synchronisiert.

Pro Tools Video Satellite – 
Bedienung

AAE-Fehler

Standardmäßig wird auf zwei gekoppelten Systemen 
der Betrieb fortgesetzt, wenn bei einem der Systeme 
ein Fehler auftritt und der Transport anhält.

Das Administratorsystem kann so konfiguriert 
werden, dass die Wiedergabe anhält, wenn im 
Pro Tools Video Satellite-System oder einem 
anderen Satellite Link-System ein AAE-Fehler 
auftritt.

So löschen Sie ein Fehlerdialogfeld im Pro Tools 
Video Satellite-System über das Pro Tools-
Hauptsystem:

 Klicken Sie auf dem anderen gekoppelten 
System im Transport-Fenster bei gedrückter 
Umschalt-Taste auf die Satellite Link-
Schaltfläche des vom Fehler betroffenen 
Systems.

Link-Steuerelemente im Transport-Fenster

LINK-Taste

Satellite Link-Schaltflächen

Wenn das Administratorsystem zur 
Übertragung der Wiedergabe-Selektion 
konfiguriert wurde, werden diese Selektionen 
an das Pro Tools Video Satellite-System 
übertragen. Selektionen aus dem Pro Tools 
Video Satellite-System werden jedoch nicht 
an das Administratorsystem übertragen.
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So richten Sie das Pro Tools Video Satellite-System 
so ein, dass der Transport auf beiden Systemen 
angehalten wird, wenn ein Fehler auftritt:

 Vergewissern Sie sich auf dem Administrator-
Pro Tools-System, dass in den Synchronization-
Voreinstellungen die AAE Errors Stop All Linked 

Systems-Option aktiviert ist.

Modaldialoge

Auf gekoppelten Systemen wird die Wiedergabe 
angehalten, wenn ein Modaldialogfeld (z. B. I/O 
Setup, Hardware Setup oder Playback Engine) auf 
einem der gekoppelten Systeme offen ist. 
. 

Positionieren von Video in der 
Pro Tools-Timeline im Spot-
Modus
Sobald eine Session auf dem Pro Tools-System 
erstellt (oder eine vorhandene Session geöffnet) und 
das Video importiert wurde, muss das Video auf die 
korrekte Startzeit gesetzt werden, damit es synchron 
mit dem Audio auf dem Pro Tools-Hauptsystem 
läuft. Video kann auf die gewünschte Startzeit 
positioniert werden, indem der Timecode- oder der 
Feet+Frames-Wert angepasst wird. 

Ausgleichen unterschiedlicher 
Startzeiten in Pro Tools und 
Pro Tools Video Satellite
In einigen Fällen sollte das Pro Tools Video 
Satellite-System versetzt vom 
Administratorsystem laufen, um Abweichungen 
externer Geräte oder Unterschiede in der Session-
Startzeit zu verarbeiten.

Sie können den Offset-Wert steuern, indem Sie die 
Timecode Offset-Parameter auf dem Pro Tools 
Video Satellite-System ändern.

So gleichen Sie unterschiedliche Startzeiten aus:

1 Wählen Sie in Pro Tools Setup > Session. 
Das Session Setup-Fenster wird angezeigt.

2 So gleichen Sie den Offset zwischen Pro Tools 
und Pro Tools Video Satellite im External 
Timecode Offsets-Abschnitt aus:

• Wenn die Startzeit des Videoclips in Video 
Satellite vor der Startzeit der Pro Tools-Session 
liegt, geben Sie einen positiven Timecode-Wert 
in das Satellite Offset-Feld ein.

• Wenn die Startzeit des Videoclips in Video 
Satellite nach der Startzeit der Pro Tools-
Session liegt, geben Sie einen negativen 
Timecode-Wert in das Satellite Offset-Feld ein.

Wenn auf einem der Systeme ein AAE-Fehler 
auftritt, leuchtet die Satellite Link-
Schaltfläche im Transport-Fenster des 
anderen Systems rot auf. Zeigen Sie mit der 
Maus auf die Schaltfläche, um den Fehler bei 
Bedarf anzuzeigen.

Es kann auf einem System keine 
Wiedergabe erfolgen, wenn ein 
Modaldialogfeld geöffnet ist.
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Kompensieren einer 
monitorbedingten 
Ausgabeverzögerung
Bei vielen Monitoren kommt es bei der 
Wiedergabe zu einer Verzögerung der 
Videoausgabe um einen oder mehrere Frames. 
Diese Verzögerung können Sie ausgleichen, 
indem Sie die Videoausgabe um die erforderliche 
Anzahl von Frames verschieben.

So stellen Sie die Anzahl der Frames ein, um die 
die Videoausgabe verschoben werden soll:

1 Wählen Sie im Video Satellite-System Setup > 

Video Sync Offset.

2 Geben Sie im Video Sync Offset-Feld einen 
positiven Wert ein, der der Verzögerung auf den 
Monitoren entspricht. Möglicherweise müssen 
Sie mit verschiedenen Einstellungen 
experimentieren. 
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Kapitel 55: Avid Video Satellite

Avid Video Satellite ist eine leistungsstarke 
Postproduktionsoption für Pro Tools, wobei ein 
separater Computer zum Einsatz kommt, auf dem 
Avid Media Composer oder Symphony zur 
synchronisierten Videowiedergabe, -einspielung 
und -konvertierung läuft.

Avid Video Satellite kann ein einzelnes Media 
Composer- bzw. Symphony-System in einer 
Satellite-Konfiguration verwenden. Avid Video 
Satellite gibt komplette Sequenzen wieder und 
erfordert kein Video-Mixdown. Für Avid Video 
Satellite ist ein Pro Tools HD-Administrator in der 
Satellite-Konfiguration erforderlich.

Media Composer oder Symphony mit der Video 
Satellite-Option kann Videomaterial über folgende 
Avid-Video-Peripheriegeräte einspielen und 
ausgeben:

• Avid Nitris DX

• Avid Mojo DX

Anforderungen für Avid Video 
Satellite
Für Avid Video Satellite sind die folgenden 
Systemkomponenten erforderlich:

• von Avid qualifizierter Computer mit Mac oder 
Windows

• Pro Tools HD-Software mit Avid HDX- und 
HD Native-Hardware 

• SYNC HD

• Ein zweiter von Avid qualifizierter Computer 
für Media Composer oder Symphony

• System-ID und Seriennummer für 
Media Composer bzw. Symphony oder Avid-
Dongle (im Lieferumfang von Media Composer 
oder Symphony enthalten)

• Avid-Video-Peripheriegerät (optional; für 
Videoausgabe in hoher Qualität erforderlich)

Avid Video-Peripheriegeräte 

Wenn Sie SD-Video (oder in SD konvertiertes 
1080 HD-Video) in hoher Qualität framegenau 
wiedergeben möchten, benötigen Sie ein 
zusätzliches Avid-Video-Peripheriegerät mit 
entsprechenden I/O-Funktionen.

Media Composer unterstützt die folgenden Avid-
Video-Peripheriegeräte:

• Avid Nitris DX

• Avid Mojo DX

Für Avid-Video-Peripheriegeräte sind die 
folgenden Komponenten erforderlich:

• NTSC-/PAL-Black-Burst-Generator

• TriLevel-Sync-Generator (für HD-fähige Avid-
Video-Peripheriegeräte)
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Optionen für die 
Videoausgabe
Avid Video Satellite unterstützt die Videoausgabe 
unter Verwendung einer beliebigen der folgenden 
Konfigurationen:

• Wiedergabe auf einem externen Monitor mit 
Avid Nitris DX Ausgabeformate sind unter 
anderem HD/SD-SDI, HDMI und HD/SD 
Analog.

• Wiedergabe auf einem externen Monitor mit 
Avid Mojo DX Ausgabeformate sind unter 
anderem HD/SD-SDI und HDMI.

• Vollbildwiedergabe auf dem primären oder 
sekundären Computermonitor über den DVI-
Ausgang

• Wiedergabe auf einem externen Monitor mit 
unterstützter Videohardware von Drittanbietern

Wiedergabe auf einem externen 
NTSC- oder PAL-Monitor
Media Composer und Symphony erfordern Avid-
Videoperipherie zur hochwertigen, framegenauen 
Wiedergabe von SD-Video (oder in SD-Video 
konvertierten 1080 HD-Videomaterials) auf einem 
externen NTSC- oder PAL-Monitor.

Bei der Ausgabe von 1080 HD-Video mit dieser 
Konfiguration können Sie entweder eine HD-
Sequenz in SD-Video transkodieren oder ein 
ganzes HD-Projekt in Echtzeit in SD-Video 
konvertieren. 

Wenn Sie Avid Nitris DX oder Mojo DX 
verwenden, können Sie 1080 HD-Video in Echtzeit 
im Softwaremodus in SD-Video konvertieren. 

Video Satellite unterstützt die Hardware-basierte 
Konvertierung nicht.

Wiedergabe auf einem externen 
HD-SDI-Monitor
(Nur Avid Nitris DX oder Mojo DX)

Media Composer erfordert ein HD-fähiges Avid-
Video-Peripheriegerät (Nitris DX oder Mojo DX) 
zur hochwertigen, framegenauen Wiedergabe von 
nativem HD-Videomaterial auf einem externen 
HD-SDI-Monitor. 

Vollbildwiedergabe auf einem 
Computermonitor über den DVI-
Ausgang
Wenn eine unterstützte Grafikkarte installiert ist, 
ermöglicht Media Composer Video Satellite die 
Vollbildwiedergabe von SD- oder HD-
Videomaterial über den DVI-Ausgang auf dem 
primären oder sekundären Monitor. 

Video-Framerate und Monitor-
Aktualisierungsrate

Bei der Ausgabe von Video auf einem Monitor mit 
einer Aktualisierungsrate, die sich von der Video-
Framerate unterscheidet (was bei der Ausgabe 
über den DVI-Ausgang häufig der Fall ist), kommt 
es zu sichtbaren Artefakten und nicht 
synchronisiertem Audio und Video. Dies tritt 
beispielsweise bei der Wiedergabe eines 24-fps-
Videoclips auf einem DVI-Monitor mit einer 
Aktualisierungsrate von 75 Hz auf. 

Wenn Ihr Workflow eine hochwertige Wiedergabe 
erfordert, müssen Sie das Videomaterial über ein 
Avid-Peripheriegerät auf einem Video-Monitor 
ausgeben.

720p-Projekte können nicht konvertiert 
werden. 

Ausführliche Informationen zur Qualität der 
DVI-Ausgabe auf dem primären oder 
sekundären Monitor finden Sie unter „Avid 
Video Satellite-Workflows“ auf Seite 1313.
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Die Artefakt- und Audio-Video-
Synchronisierungsprobleme machen sich 
folgendermaßen bemerkbar:

„Frame-Tearing“ und „stotterndes“ Videobild – 
„Frame-Tearing“ bezeichnet horizontale 
Verzerrungen bei Sequenzen mit schnellen 
Bewegungen oder starken Bearbeitungen. Bei der 
„stotternden“ Wiedergabe wird das Videobild 
leicht verschoben.

Sie können immer nur eines dieser Probleme 
beheben, indem Sie im Dialogfeld „Full Screen 
Playback Settings“ die Option „Flip On Vertical 
Sync“ verwenden.

Versetzte Synchronisation von Audio und Video 

– die Synchronisation von Audio und Video 
variiert leicht von Bild zu Bild. Dies ist zwar 
normalerweise nicht wahrnehmbar, aber präzise 
Messgeräte können Versätze in der AV-
Synchronisation von bis zu und sogar über 1/2 Bild 
erfassen. Das ist beim Einsatz der Grafikkarte des 
Computers normal und beeinträchtigt Erfassen, 
Bearbeitung oder Layback nicht.

Unterstützte 
Videoauflösungen
Video Satellite für Media Composer und 
Symphony unterstützt Import, Erfassung und 
Wiedergabe einer großen Zahl verschiedener 
Videoauflösungen und Framerates (darunter 
HD-Video).

Weitere Informationen zu den unterstützen 
Auflösungen und Framerates finden Sie in der 
Online-Hilfe zu Avid Media Composer oder auf 
der Website von Avid (www.avid.com).

So starten Sie die Online-Hilfe in Media Composer:

• Wählen Sie Help > Online Help.

Avid Video Satellite-
Workflows
In den folgenden Abschnitten werden Workflows 
für den Einsatz von Pro Tools mit 
Media Composer oder Symphony mit Avid Video 
Satellite-Option beschrieben:

• Verbinden von Pro Tools mit einem Video 
Satellite-System

• Verknüpfen von Pro Tools mit einem Video 
Satellite-System

• Erfassen von Audio und Video

• Batch-Erfassung von Audio und Video

• Layback von Audio und Video

Verwenden von Video 
Satellite in einer 
Avid Interplay-Umgebung
Für Video Satellite-Benutzer kann das 
Avid Interplay-System für die Dateiverwaltung 
über das Netzwerk nützlich sein. Weitere 
Informationen zur Verwendung von Interplay 
mit Pro Tools finden Sie im Pro Tools Avid 
Interplay-Handbuch.
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Verbinden von Pro Tools mit 
einem Video Satellite
Damit der Transport auf dem Pro Tools- und dem 
Video Satellite-System synchronisiert werden 
kann, müssen Sie verknüpft werden. Vorher 
müssen allerdings grundlegende 
Kommunikationskanäle eingerichtet werden. 
Nachdem die Kommunikation zwischen dem 
Pro Tools- und dem Video Satellite-System 
hergestellt wurde, sind sie verbunden.

Damit Sie das Pro Tools- und Video Satellite-
System verbinden können, müssen Sie zuerst über 
Ethernet verbunden werden.

Außerdem muss die Video Satellite-Option auf 
dem Media Composer-System aktiviert sein und 
die Systeme müssen verbunden sein.

Bedingungen für das Verbinden 
von Pro Tools- und 
Video Satellite-Systemen
Die folgenden Bedingungen gelten beim 
Verbinden von Pro Tools- und Video Satellite-
Systemen:

• Wenn Sie eine Instanz von Pro Tools beenden, 
die als Administrator für ein Video Satellite-
System fungiert, wird das Video Satellite-
System freigegeben und kann mit anderen 
Pro Tools-Systemen verbunden werden.

• Wenn Sie Pro Tools beenden, während ein 
Video Satellite-System verbunden ist, versucht 
Pro Tools beim nächsten Start, die Verbindung 
zum gleichen System wiederherzustellen.

• Besteht eine Verknüpfung zu einem 
Video Satellite-System, verfolgt Pro Tools den 
MIDI-Timecode (MTC) nicht.

Beheben von Fehlern beim 
Verbinden von Satellite-
Systemen
Wenn das Satellite-System nicht im 
Administrator-Popup-Menü erscheint, prüfen 
Sie Folgendes:

1 Vergewissern Sie sich, dass Media Composer 
bzw. Symphony ordnungsgemäß ausgeführt 
wird.

2 Wählen Sie in Media Composer im Project-
Fenster Settings > Video Satellite. Vergewissern 
Sie sich, dass „Video Satellite Mode“ 
aktiviert ist.

3 Wählen Sie in Pro Tools auf der Satellite-Seite 
des Peripherals-Dialogfelds einen anderen 
Ethernet-Port aus dem Interface-Menü. Viele 
Computer haben mehrere Ethernet-Ports oder 
„Schnittstellen“. Wählen Sie hier die 
Schnittstelle aus, die mit demselben Netzwerk 
verbunden ist wie das Satellite-System.

4 Klicken Sie im Project-Fenster von 
Media Composer bzw. Symphony auf die 
Settings-Registerkarte. Doppelklicken Sie 
anschließend auf Video Satellite Settings und 
prüfen Sie, ob der TCP/UDP-Port mit dem auf 
der Satellite-Seite des Peripherals-Dialogfelds 
ausgewählten identisch ist. (Der Standardport 
ist jeweils 28282.)

Wenn Sie außer Media Composer noch 
andere Anwendungen ausführen, kann die 
Funktion der Software beeinträchtigt werden 
und es kann z. B. zu AV-
Synchronisierungsfehlern, ausgelassenen 
Frames und stotterndem Audio kommen. Sie 
sollten daher keine anderen Anwendungen 
starten, wenn Media Composer läuft. Dies 
kann unabhängig davon auftreten, ob 
Video Satellite aktiviert ist oder nicht.

Damit Video Satellite ordnungsgemäß 
funktioniert, muss der TCP/UDP-Port 
zwischen 1024 und 65534 liegen.
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5 Wenn die TCP/UDP-Port-Einstellungen 
übereinstimmen, bitten Sie den 
Netzwerkadministrator, zu prüfen, ob der 
angezeigte Port im Netzwerk blockiert wird.

6 Prüfen Sie, ob alle Ethernet-Kabel 
ordnungsgemäß angeschlossen sind und 
funktionieren. Ob ein Ethernet-Port aktiv ist, 
wird oft über eine LED angezeigt.

7 Die Video Satellite-Wiedergabe funktioniert 
unter folgenden Bedingungen nicht:

• Bestimmte Dialogfelder sind in Pro Tools oder 
Media Composer geöffnet.

• Media Composer ist nicht die aktive Anwendung.

• In Pro Tools ist keine Session geöffnet bzw. in 
Media Composer keine Sequenz.

Angleichen von 
Media Composer- und 
Pro Tools-Einstellungen in 
einem Video Satellite-System
Damit die Wiedergabe zwischen Pro Tools und 
Media Composer exakt synchronisiert werden 
kann, müssen folgende Parameter angeglichen 
werden:

• Media Composer Project Type und Pro Tools 
Timecode Rate, Clock Reference und Video 
Format

• Pro Tools Audio Pull-Up-Einstellung und 
Media Composer Edit Play Rate

• Timecode-Format (Drop Frame oder Non-Drop 
Frame)

Damit Pro Tools synchron mit Media Composer 
bzw. Symphony mit Video Satellite-Option 
wiedergibt, hängen diese Einstellungen alle 
voneinander ab. Sollte auch nur eine dieser 
Einstellungen nicht übereinstimmen, zeigt 
Pro Tools eine Fehlermeldung an. 

Der Media Composer Starting TC-Timecode und 
die Pro Tools-Session-Startzeit müssen nicht exakt 
übereinstimmen, sollten sich aber so nahe wie 
möglich beieinander liegen.

Bei der Arbeit mit 24p- und 23,976-Projekten zeigt 
Media Composer standardmäßig Frames mit dem 
29,97-fps-Timecode an. Damit der Timecode in 
Pro Tools und Media Composer bzw. Symphony 
in 24p- oder 23,976-Projekten synchron bleibt, 
klicken Sie auf die Timecode-Anzeige über dem 
Record Monitor und wählen Sie Sequence > 

Timecode > 24 > Mas.

Angleichen von 
Media Composer Project Type 
und Pro Tools Timecode Rate, 
Clock Reference und Video 
Format
In diesem Abschnitt wird beschrieben, wie Sie den 
„Project Type“ von Media Composer an die 
Einstellungen „Timecode Rate“, „Clock 
Reference“ und „Video Format“ von Pro Tools 
angleichen.

Um Synchronisationsprobleme bei der 
Postproduktion zu vermeiden, sollten Sie in 
den meisten Fällen die Einstellungen in 
Pro Tools so ändern, dass sie mit denen der 
in Media Composer geöffneten Sequenz 
übereinstimmen. 
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So stellen Sie sicher, dass das Video Satellite-
System die richtigen Einstellungen bei der 
Wiedergabe bzw. Erfassung nutzt:

1 Klicken Sie in Media Composer im Project-
Fenster auf die Format-Registerkarte.

2 Wählen Sie die gewünschte Einstellung aus 
dem Project Type-Popup-Menü.

3 Wählen Sie in Pro Tools Setup > Session.

4 Wählen Sie eine Timecode-Einstellung aus dem 
Timecode Rate-Popup-Menü, die mit der 
Project Type-Einstellung in Media Composer 
kompatibel ist.

5 Vergewissern Sie sich, dass ein kompatibler 
Taktgeber verfügbar und ordnungsgemäß 
angeschlossen ist.

6 Wählen Sie die angeschlossene Taktreferenz 
aus dem Clock Reference-Popup-Menü.

7 Wählen Sie ein kompatibles Videoformat aus 
dem Video Ref Format-Popup-Menü.

Angleichen von Audio Pull-Up 
und Edit Play Rate
Standardmäßig gibt Media Composer Sequenzen 
bei der Framerate wieder, die im Namen des 
Projekttyps angegeben ist. Beispiel: Ein 25i PAL-
Projekt wird bei 25 fps wiedergegeben. Die 
wichtige Ausnahme ist 30i NTSC, das bei 
29,97 fps wiedergegeben wird. 

Bei der Arbeit mit 23,976-, 24p NTSC-, 24p PAL- 
und 25p PAL-Projekten können Sie die 
Wiedergaberate (Edit Play Rate) ändern, ohne die 
anderen Eigenschaften zu beeinträchtigen, um die 
Wiedergabe leicht zu beschleunigen oder zu 
verlangsamen. Dies ist die Videoentsprechung zur 
Audio Pull-Up/Down-Einstellung in Pro Tools.

So ändern Sie die Edit Play Rate:

1 Öffnen Sie auf der Settings-Registerkarte des 
Project-Fensters „Film and 24P Setting“.

2 Wählen Sie die Edit Play Rate entsprechend der 
Konfiguration in der folgenden Tabelle.

So ändern Sie die Audio Pull-Up/Down-
Einstellungen in Pro Tools:

1 Wählen Sie in Pro Tools Setup > Session.

2 Wählen Sie im Timecode Settings-Abschnitt 
des Session Setup-Fensters im Audio Rate Pull 
Up/Down-Popup-Menü einen Wert.

3 Klicken Sie auf OK, um die neue Pull-Up- bzw. 
Pull-Down-Rate auf die Session anzuwenden.

In den meisten Fällen ist das Ändern des 
Projekttyps in Media Composer nicht 
empfehlenswert. Sie sollten die Timecode-
Rate in Pro Tools ändern, es sei denn, Sie 
konvertieren ein HD-Projekt in SD. Weitere 
Informationen hierzu finden Sie im 
Pro Tools-Referenzhandbuch.

Der Project Type wird auch bei Erstellung 
eines neuen Projekts in Media Composer 
erstellt.

Die Video Ref Format-Einstellung kann für 
die meisten HD-Framerates nicht geändert 
werden.

24p-Projekte (PAL und NTSC) nutzen eine 
Standard-Edit Play Rate, die nicht mit der 
Projektrate übereinstimmt. Die Standardrate 
für 24p PAL ist 25 fps und 23,976 fps für 
24p NTSC.
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Kompatibilitätstabelle

Die folgende Tabelle beschreibt die Kompatibilität zwischen dem Avid Project Format und Edit Play Rate 
sowie Pro Tools-Timecode Rates, Audio Pull-Up/Down-Rate, Clock Reference und Video Format.

Rate- und Sync Ref-Kompatibilität zwischen Avid und Pro Tools

Media Composer bzw. Symphony Pro Tools

Avid Project 
Format

Edit 
Play 
Rate

Mojo DX oder 
Nitris DX 
Video Ref

PT 
Timecode 

Rate

PT Audio Rate 
Pull Up/Down

SYNC HD 
Video Ref 

Format 

23,976p NTSC 23,976 NTSC 23,976 None NTSC

24 NTSC 24 0,1 % Up NTSC

24p NTSC 24 NTSC 24 None NTSC

23,976 NTSC 23,976 0,1 % Down NTSC

30i NTSC 29,97 NTSC 29,97 Variabel NTSC

24p PAL 24 PAL 24 None PAL

25 PAL 25 4 % Up PAL

25p PAL 25 PAL 25 None PAL

24 PAL 24 4 % Down PAL

25i PAL 25 PAL 25 None PAL

720p/23,976 23,976 720p/59,94* 23,976 None 720p/59,94 
(oder NTSC)

720p/25 25 720p/50 25 None 720p/50 
(oder PAL)

720p/29,97 29,97 720p/59,94 29,97 None 720p/59,94 
(oder NTSC)

720p/50 50 720p/50* 25 None 720p/50 
(oder PAL)

720p/59,94 59,94 720p/59,94* 29,97 None 720p/59,94 
(oder NTSC)
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* Obwohl Media Composer das Sperren der Videoperipherie auf Black Burst- oder TriLevel-Sync bei 
diesen HD-Rates unterstützt, unterstützt Video Satellite nur mit diesen HD-Rates das Sperren von 
Media Composer-Videoperipherie auf TriLevel-Sync.

Media Composer bzw. Symphony (Forts.) Pro Tools (Forts.)

Avid Project 
Format

Edit 
Play 
Rate

Mojo DX oder 
Nitris DX 
Video Ref

PT 
Timecode 

Rate

PT Audio Rate 
Pull Up/Down

SYNC HD 
Video Ref 

Format

1080p/23,976 23,976 1080p/23,98sF 23,976 None 1080p/23,97 
(oder NTSC)

1080p/24 24 1080p/24sF 24 None 1080p/24 
(oder PAL oder 
NTSC)

1080p/25 25 1080p/25sF 
(oder 1080i/50)*

25 None 1080p/25 
(oder 1080i/50 
oder PAL)

1080p/29,97 29,97 1080i/59,94 29,97 None 1080i/59,94, 
1080psf-29,97 
(oder NTSC)

1080i/50 50 1080i/50* 25 None 1080i/50, 
1080psf-25 
(oder PAL)

1080i/59,94 59,94 1080i/59,94* 29,97 None 1080i/59,94, 
1080psf-29,97 
(oder NTSC)

Rate- und Sync Ref-Kompatibilität zwischen Avid und Pro Tools
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Anpassen des Timecode-
Formats (Drop Frame oder Non-
Drop Frame)
Pro Tools und Media Composer müssen auf 
dasselbe Timecode-Format (entweder Drop-
Frame oder Non-Drop-Frame) eingestellt werden.

So gewährleisten Sie, dass die Timecode Format-
Einstellungen kompatibel sind:

1 Wählen Sie in Pro Tools Setup > Session. 
Wenn im Timecode Rate-Popup-Menü „DF“ 
nach der Framerate angezeigt wird, ist 
Pro Tools auf Drop-Frame eingestellt.

2 Klicken Sie in Media Composer mit der rechten 
Maustaste in den Record Monitor und wählen 
Sie im Kontextmenü die Sequence Report-
Option.

Wenn die Ziffern in den TC-Feldern durch 
Semikolons anstatt Doppelpunkte getrennt sind, 
ist das Projekt auf Drop-Frame eingestellt.

3 Wenn beide Timecode-Formate nicht 
übereinstimmen, haben Sie folgende 
Möglichkeiten:

• Um Pro Tools zu zwingen, das Timecode-
Format von Media Composer zu verwenden, 
wählen Sie das kompatible Timecode-Format 
aus dem Timecode Rate-Popup-Menü.

• Um Media Composer und die Timecode-Rate 
von Pro Tools anzugleichen, geben Sie 
zwischen den Zahlen im Starting TC-Feld 
Semikolons (Drop-Frame) oder Doppelpunkte 
(Non-Drop-Frame) ein und drücken Sie die 
Eingabetaste.

In bestimmten Projektformaten kann Media 
Composer für Drop-Frame bzw. Non-Drop-
Frame konfiguriert werden, während die 
entsprechende Pro Tools-Timecode-Rate 
nur auf Non-Drop-Frame eingestellt 
werden kann. In solchen Fällen sendet 
Media Composer Non-Drop-Timecode-
Daten an Pro Tools, auch wenn dieses 
Programm auf Drop-Frame eingestellt ist. 
In Media Composer sind dies folgende 
Projektformate: 23,976p NTSC, 24p NTSC 
und 720p/23,976.

Clip Info-Dialogfeld (Media Composer, oben) und ein 
Teil des Session Setup-Fensters (Pro Tools, unten)

Starting 
TC-Feld

Session 
Start-Feld

Timecode 
Rate
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Angleichen der 
Media Composer-Timecode-
Einstellung „Starting TC“ und 
„Session Start“ in Pro Tools
In fast allen Fällen befindet sich das erste 
Videobild am Anfang der Media Composer-
Sequenz. Pro Tools-Sessions enthalten jedoch oft 
leeres Material am Anfang, damit ein Countoff 
oder Stille eingefügt werden kann. 

Beispiel: Die Media Composer-Sequenz beginnt 
um 1:00:00:00 und die entsprechende Pro Tools-
Session um 00:59:55:00, also gibt es fünf 
Sekunden Stille, bevor das Audiomaterial beginnt.

So legen Sie die Standardstartzeit für neue 
Sequenzen in Media Composer fest:

1 Klicken Sie im Project-Fenster auf die Settings-
Registerkarte und doppelklicken Sie 
anschließend auf die General-Einstellung.

2 Geben Sie im Default Starting TC-Feld den 
gewünschten Start-Timecode ein.

So ändern Sie die Startzeit für eine vorhandene 
Sequenz in Media Composer:

1 Öffnen Sie in Media Composer die Bin, die die 
gewünschte Sequenz enthält.

2 Passen Sie bei Bedarf die Größe des Bin-
Fensters an, damit Sie die Start-Spalte sehen 
können.

3 Geben Sie in der Start-Spalte der gewünschten 
Sequenz die neue Startzeit unter Verwendung 
von Semikolons (Drop-Frame) oder 
Doppelpunkten (Non-Drop-Frame) ein und 
drücken Sie die Eingabetaste.

4 Klicken Sie zum Bestätigen auf OK.

Kompensieren unterschiedlicher 
Sequenzstartzeiten in Pro Tools und 
Video Satellite

Sie können Offsets kompensieren, die auftreten 
können, wenn sich die Startzeit einer Avid-
Sequenz in Media Composer und Pro Tools 
unterscheidet.

So kompensieren Sie unterschiedliche 
Sequenzstartzeiten:

1 Wählen Sie in Pro Tools Setup > Session. 
Das Session Setup-Fenster wird geöffnet.

2 So kompensieren Sie den Offset zwischen 
Pro Tools und Video Satellite im der External 
Timecode Offset-Abschnitt:

• Wenn die Startzeit der Video Satellite-Sequenz 
vor der Startzeit der Pro Tools-Sequenz liegt, 
geben Sie einen positiven Timecode-Wert in das 
Satellite Offset-Feld ein.

• Wenn die Startzeit der Video Satellite-Sequenz 
nach der Startzeit der Pro Tools-Sequenz liegt, 
geben Sie einen negativen Timecode-Wert in das 
Satellite Offset-Feld ein.

Kompensieren einer 
monitorbedingten 
Ausgabeverzögerung
Bei vielen Monitoren kommt es bei der 
Wiedergabe zu einer Verzögerung der 
Videoausgabe um einen oder mehrere Frames. 
Diese Verzögerung können Sie ausgleichen, 
indem Sie die Videoausgabe um die erforderliche 
Anzahl von Frames verschieben.

In manchen Fällen kann es zu einem Fehler 
kommen, wenn Sie versuchen, die 
Wiedergabe in Media Composer zu einem 
Zeitpunkt zu starten, der früher als eine 
Minute vor dem Beginn der Pro Tools-
Session liegt. Legen Sie in diesem Fall eine 
frühere Startzeit für die Pro Tools-Session 
fest.
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So stellen Sie die Anzahl der Frames ein, um die 
die Videoausgabe verschoben werden soll:

1 Wählen Sie in Media Composer Settings > 

Video Satellite Settings.

2 Geben Sie im Video Satellite Offset-Feld einen 
positiven Wert ein, der der Verzögerung auf den 
Monitoren entspricht. Möglicherweise müssen 
Sie mit verschiedenen Einstellungen 
experimentieren.

Verknüpfen von Pro Tools- 
und Video Satellite-Systemen 
und Aufheben der 
Verknüpfung
Nachdem Sie ein einzelnes Pro Tools HD-System 
und ein Avid Video Satellite-System in einem 
Satellite Link-Netzwerk miteinander verbunden 
und konfiguriert haben, können Sie deren 
Funktionen über Steuerelemente in Pro Tools und 
Media Composer steuern. Wenn jedoch in einem 
Satellite Link-Netzwerk mit einem Avid Video 
Satellite-System mehr als ein Pro Tools HD-
System verbunden und konfiguriert ist, kann die 
Wiedergabe nur von einem Pro Tools HD-System 
im Netzwerk gestartet werden.

Wenn sie verknüpft sind, unterstützen Pro Tools 
und Media Composer die folgenden 
Transportvorgänge:

• Mit Audiowiedergabe:

• Play

• Half-speed Play

• Loop Play

• Shuttle

• Scrub

• Record

• Loop Record

• FF/REW (wobei in Pro Tools die 
Voreinstellung „Audio During FF/RW“ 
aktiviert ist)

• Ohne Audiowiedergabe:

• Locate

• Nudge

• Selecting

Wenn Sie in Media Composer die Tasten J, K und 
L für die Shuttle-Wiedergabe verwenden, gibt 
Pro Tools Audio bei einfacher Geschwindigkeit 
vorwärts, aber nicht rückwärts oder in den anderen 
Wiedergabegeschwindigkeiten wieder.

Link-Steuerelemente
Wenn ein Pro Tools HD-System als Administrator 
konfiguriert ist, können folgende Steuerelemente 
im Transport-Fenster eingeblendet werden: 

Link-Schaltfläche – steuert den 
Verknüpfungsstatus des lokalen Systems.

Die Standardfunktionen der Pro Tools-Option 
„MachineControl“ sind unverändert und 
unabhängig von den Video Satellite-
Transportfunktionen. MIDI Machine Control- 
oder MIDI-Timecode-Chasing sind jedoch 
nicht möglich, während eine Verknüpfung zu 
einem Video Satellite-System besteht.

Die Modi „Trim“, „Color Correction“ und 
„Effects“ von Media Composer und 
Symphony werden von Avid Video Satellite 
nicht unterstützt.

Aktivieren Sie in Media Composer die Play 
Preparation Delay-Option (Settings > Video 
Satellite), um mögliche Fehler beim 
Wiedergabestart in Sequenzen mit hoher 
Bandbreite oder nicht gerenderten Effekten zu 
vermeiden. Aktivieren Sie die Loop 
Preparation Delay-Option, um ähnliche 
Probleme bei der Loop-Wiedergabe zu 
vermeiden.
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Satellite Link-Schaltflächen – steuern den 
Verknüpfungsstatus der anderen Satellite-
Systeme. In jedem System entspricht eine dieser 
Schaltflächen der Haupt-Link-Schaltfläche des 
jeweiligen Systems.

Link-Schaltflächen leuchten auf, wenn die 
Verknüpfung aktiv ist.

So zeigen Sie Link-Steuerelemente im Transport-
Fenster an:

 Wählen Sie View > Transport > Synchronization 
und View > Transport > Expanded.

So verknüpfen Sie das lokale Pro Tools-System 
bzw. heben die Verknüpfung auf:

 Klicken Sie im Transport-Fenster auf die Link-
Schaltfläche. 

So verknüpfen Sie andere Satellite-Systeme bzw. 
heben die Verknüpfung auf:

 Klicken Sie im Transport-Fenster auf die 
entsprechende Satellite Link-Schaltfläche.

So verknüpfen Sie das Video Satellite-System 
bzw. heben die Verknüpfung von Media Composer 
aus auf:

 Klicken Sie auf die Satellite Link-Schaltfläche, 
um sie zu aktivieren (grün, verknüpft) oder zu 
deaktivieren (grau, Verknüpfung aufgehoben).

 Sie können den Verknüpfungsstatus ändern, 
indem Sie Umschalt + Alt + L (Windows) 
drücken.

Steuern der Verknüpfung mit 
einer Bedienoberfläche

So aktivieren bzw. deaktivieren Sie die Link-
Schaltfläche auf dem Pro Tools-System 
(ICON und C|24):

 Halten Sie die Alt- (Windows) bzw. die Ctrl-
Taste (Mac) gedrückt und klicken Sie auf der 
Bedienoberfläche auf die Online-Schalter.

So aktivieren bzw. deaktivieren Sie die 
Satellite Link-Schaltflächen (nur D-Control oder 
D-Command):

1 Halten Sie die Befehlstaste (Mac) bzw. Strg-
Taste (Windows) gedrückt und drücken Sie auf 
der Bedienoberfläche auf die Modes-
Schaltfläche, um alle verknüpften Systeme in 
der Soft Key-Anzeige einzublenden.

2 Die Modes-Schaltfläche leuchtet. Wenn Sie 
erneut auf die Modes-Schaltfläche klicken, 
wird der Satellite Link-Modus beendet.

3 Sie können dann auf die Soft Keys klicken, um 
den entsprechenden Computer zu verknüpfen 
bzw. die Verknüpfung aufzuheben.

Link-Steuerelemente im Pro Tools-Transport-Fenster

LINK-Taste

Satellite Link-Schaltflächen

Link-Schaltflächen blinken kurz, wenn der 
Netzwerktakt eingerichtet wird.

Wenn Media Composer einen Fehler anzeigt, 
wird die Satellite Link-Schaltfläche für das 
Video Satellite-System in Pro Tools rot. 
Zeigen Sie mit der Maus auf die Link-
Schaltfläche, um die Meldung anzuzeigen. 
Um die Meldung auszublenden, klicken Sie 
bei gedrückter Umschalttaste auf die 
Satellite Link-Schaltfläche des 
Video Satellite-Systems.
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Video Satellite und EUCON-
Bedienoberflächen

Eine Reihe von Steuerelementen zur 
Systemverknüpfung wurden für EUCON 
angepasst. Weitere Informationen zur Steuerung 
von Video Satellite-Funktionen mit EUCON-
Geräten finden Sie im Pro Tools-EUCON-
Handbuch.

Einspielen von Audio- und 
Videomaterial mit einem 
Video Satellite-System
Sie können ein Video Satellite-System verwenden, 
um Audiomaterial in Pro Tools und Videomaterial 
in Media Composer in einem Durchgang zu 
erfassen.

Vor dem Erfassen von Audio- und 
Videomaterial
Bevor Sie Audio- und Videomaterial von Band 
erfassen können, müssen folgende Verbindungen 
hergestellt werden.

So stellen Sie eine Verbindung zu einer Avid-
Videoperipherie her:

1 Verbinden Sie die gewünschten Ausgänge des 
Videodecks mit den entsprechenden Eingängen 
der Videoperipherie.

2 Verbinden Sie die Audioquelle mit den 
Eingängen des primären Pro Tools HD-Audio-
Interface.

So stellen Sie eine Verbindung ohne Avid-
Videoperipherie her:

 Bei FireWire-Verbindungen schließen Sie das 
FireWire-Kabel direkt am FireWire-Anschluss 
des Media Composer-Systems an. 

Da Video- und Audiomaterial in einem Signal über 
FireWire gestreamt wird, müssen keine 
Audioeingänge verbunden werden.

Wenn Sie Videomaterial über FireWire erfassen, 
müssen Sie sowohl Audio- als auch Videomaterial 
in Media Composer erfassen, da über das 
FireWire-Kabel Video- und Audiomaterial 
übertragen wird. Sie können das Audiomaterial 
dann in Pro Tools exportieren.

Bedingungen für das Erfassen 
von Audio und Video
Die folgenden Bedingungen gelten beim Erfassen 
von Audio- und Videomaterial mit einem 
Video Satellite-System:

• Aufgrund technischer Einschränkungen ist das 
Audiomaterial beim Erfassen von Videomaterial 
aus einem Gerät, das über eine 1394-Verbindung 
gesteuert wird, um drei Viertel eines Frames 
verschoben.

• Wenn Sie ein 29,97-Telecine-Videoband in einem 
24 fps-Projekt erfassen möchten, müssen Sie 
zuerst Audio und Video in Media Composer 
erfassen und dann das Audio wieder in Pro Tools 
exportieren. Informationen zum manuellen 
Exportieren einer AAF-Sequenz finden Sie im 
Handbuch zu Avid Media Composer.

Weitere Informationen finden Sie im 
Handbuch zu Ihrem Pro Tools HD-Audio-
Interface.
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Konfigurieren von Pro Tools und 
Media Composer mit 
Video Satellite-Option für die 
Einspielung
Bevor Sie Pro Tools und Media Composer für die 
synchronisierte Einspielung konfigurieren können, 
müssen Sie sicherstellen, dass die Einstellungen 
der beiden Anwendungen übereinstimmen. 
Weitere Informationen finden Sie unter 
„Angleichen von Media Composer- und 
Pro Tools-Einstellungen in einem Video Satellite-
System“ auf Seite 1315.

Konfigurieren von Pro Tools für die 
Einspielung in einem Video Satellite-
System

So konfigurieren Sie Pro Tools für die Erfassung 
von Audiomaterial:

1 Wählen Sie in Pro Tools Setup > Session und 
prüfen Sie Folgendes:

• Das Clock Source-Popup-Menü muss auf 
„SYNC“ eingestellt sein.

• Das Clock Reference-Popup-Menü muss auf 
„Video Reference“ eingestellt sein.

• Ist das Clock Reference-Popup-Menü auf eine 
andere Quelle (z. B. Word Clock) eingestellt, 
stellen Sie sicher, dass die Ref Present-LED 
leuchten und die Taktreferenz, auf die SYNC 
eingerichtet ist, mit der des Videorekorders 
übereinstimmt.

2 Routen Sie die Audioeingänge auf die 
gewünschten Spuren.

3 Schalten Sie die Audiospuren scharf, auf denen 
Audiomaterial erfasst werden soll.

4 Klicken Sie auf die Record Enable-Schaltfläche 
im Transport-Fenster.

Konfigurieren von Media Composer für 
die Videoeinspielung

Avid Video Satellite unterstützt die Videoaufnahme 
in einer neuen oder vorhanden Sequenz mit den 
Aufnahme-Tools in Media Composer oder 
Symphony. Informationen zur Konfiguration finden 
Sie in der Media Composer- oder Symphony-
Dokumentation.

Wiedergabe von erfasstem Audio- und 
Videomaterial mit einem Video 
Satellite-System

Wenn Sie die Einspielung mit einem 
Video Satellite-System abgeschlossen haben, wird 
der erfasste Clip im Record Monitor und in der 
Timeline angezeigt. Audiomaterial wird in der 
Pro Tools-Timeline angezeigt.

So zeigen Sie den erfassten Clip an:

 Klicken Sie in Pro Tools bzw. Media Composer 
auf „Play“.

Erneutes Digitalisieren einer 
vorhandenen Sequenz
Media Composer kann Sequenzen öffnen, die auf 
anderen Editing-Systemen von Avid erstellt 
wurden. Sie sollten jedoch zuerst einige oder alle 
Mediendateien erneut digitalisieren, wenn sie in 
der falschen Auflösung vorliegen oder fehlen.

Wenn Sie diesen Vorgang auf einem Video 
Satellite-System ausführen, müssen Sie das 
Audiomaterial in Media Composer erfassen und 
dann eine AAF-Sequenz in Pro Tools exportieren, 
die das eingebettete Audiomaterial referenziert 
oder enthält. 
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Digitalisieren aus einer EDL
Media Composer enthält die Software Avid EDL 
Manager, mit der Sie eine EDL aus einer anderen 
Editing-Anwendung öffnen, eine Media 
Composer-Sequenz aus dieser EDL erstellen und 
anschließend erneut digitalisieren können.

Wenn Sie diesen Vorgang auf einem Video 
Satellite-System ausführen, müssen Sie das 
Audiomaterial in Media Composer erfassen und 
dann eine AAF-Sequenz in Pro Tools exportieren, 
die das eingebettete Audiomaterial referenziert 
oder enthält. 

Layback von Audio und Video 
auf Band
Mit dem Digital Cut Tool können Sie in 
Media Composer ein Layback von Audio aus 
Pro Tools und von Video aus Media Composer auf 
Band ausführen. Informationen zur Konfiguration 
finden Sie in der Media Composer-Dokumentation. 
Dafür muss sich die 9-Pin-Verbindung auf dem 
Media Composer-System befinden.

So nehmen Sie gleichzeitig Audio- und 
Videomaterial von Media Composer und 
Pro Tools auf Band auf:

1 Vergewissern Sie sich, dass das System 
folgendermaßen eingerichtet ist: 

• Der Pro Tools- und der Media Composer-
Computer mit Video Satellite-Option sind 
verknüpft.

• Die Audioausgänge des Pro Tools HD-Audio-
Interface sind mit den entsprechenden 
Audioeingängen des Videorekorders verbunden.

• Die Videoausgänge des Media Composer-
Systems sind mit dem Videorekorder verbunden.

• Wenn Sie Deck Control nutzen, wird das Deck 
Control-Kabel des Media Composer-Systems 
mit dem Videorekorder verbunden und der 
Videorekorder wird in den Remote-Modus 
geschaltet.

Die Universal Mastering-Funktion in 
Symphony wird von Video Satellite nicht 
unterstützt.

Um möglichst zu vermeiden, dass Frames 
fallengelassen werden, sollten Sie alle Effekte 
rendern, bevor Sie ein Layback ausführen.

Beim Layback auf einen SDI-Videorekorder 
oder ein 1394-Gerät, wofür eine Kombination 
von Audio- und Videomaterial im selben Stream 
erforderlich ist, müssen Sie das Audiomaterial 
aus Pro Tools in Media Composer exportieren 
oder die Audio- und Videosignale unter 
Verwendung eines entsprechenden Geräts eines 
anderen Herstellers kombinieren und dann das 
Layback der endgültigen Sequenz auf Band 
ausführen.
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2 Legen Sie ein Band in den Videorekorder ein. 

3 Um zu gewährleisten, dass der Videorekorder 
ordnungsgemäß konfiguriert ist, lesen Sie 
folgendes Thema in der Media Composer-Hilfe 
(Help > Avid Media Composer Help): 
Configuring a Deck or Multiple Decks.

4 Sie haben folgende Möglichkeiten:

• Wählen Sie einen der angezeigten Bandnamen 
und klicken Sie auf OK.

• Klicken Sie auf „New“, um der Liste ein neues 
Band hinzuzufügen.

5 Ziehen Sie die Sequenz, die Sie auf Band 
aufnehmen möchten, aus der Bin in den Record 
Monitor.

6 Wählen Sie Output > Digital Cut. Das Digital 
Cut Tool wird geöffnet.

7 Wenn Sie In- und Out-Markierungen für eine 
digitale Ausspielung setzen möchten. 

8 Sie haben folgende Möglichkeiten:

• Aktivieren Sie die Option Entire Sequence, 
um die gesamte Sequenz aufzunehmen.

• Deaktivieren Sie die Option Entire Sequence 
und setzen Sie die In- und Out-Punkte in der 
Timeline.

9 Erfolgt das Layback über eine FireWire(1394)-
Verbindung (Special > Device > IEEE 1394), 
wählen Sie im Output Mode-Popup-Menü den 
entsprechenden Ausgabemodus:

• Wenn das gesamte Material in der Timeline im 
Format DV25 bzw. DV50 vorliegt und alle 
Effekte gerendert sind, können Sie eine etwas 
höhere Ausgabequalität erreichen, indem Sie 
„DV25“ bzw. „DV50“ wählen.

• Andernfalls müssen Sie die Option „RT DV25“ 
bzw. „RT DV50“ wählen, um das gesamte 
Videomaterial in dieses Format zu transkodieren 
und zu rendern.

10 Aktivieren Sie die Option Stop on Dropped 

Frames, falls Media Composer das Band 
automatisch anhalten soll, wenn Audio bzw. 
Video nicht korrekt aufgenommen werden.

11 Aktivieren Sie die Option Add Black At Tail und 
geben Sie ein, wie viel Schwarzfilm am Ende 
der Sequenz eingefügt werden soll.

12 Aktivieren Sie eine der folgenden Deck 
Control-Optionen:

Local Mode – Sie starten die Aufnahme manuell. 

Remote Mode – Media Composer startet den 
Videorekorder und die Aufnahme, wenn der 
angegebene Timecode erreicht ist.

13 Wenn Sie „Remote Mode“ gewählt haben, 
wählen Sie eine der folgenden Optionen:

Wenn Sie Media Composer im Satellite-
Modus für 24p- und 23,976-Projekte nutzen, 
werden nur die Ausgabeformate „24“ und 
„23.976“ unterstützt. Das 29,97-
Ausgabeformat (+25 % 
Wiedergabegeschwindigkeit ohne Pull-
Down) wird im Satellite-Modus für 24p- und 
23,976p-Projekte nicht unterstützt.

Digital Cut Tool



Kapitel 55: Avid Video Satellite 1327

Sequence Time – startet die Aufnahme anhand der 
Sequenzzeit. Beispiel: Wenn die Sequenz bei 
01:00:00:00 in der Timeline beginnt, startet 
Media Composer die Aufnahme, wenn das Band 
01:00:00:00 erreicht.

Record Deck Time – startet die Aufnahme an der 
Stelle, an der der Videorekorder gerade geparkt ist.

Mark In Time – startet die Aufnahme bei dem im 
Fenster oben rechts neben den Transport-
Steuerelementen eingegebenen Timecode.

14 Aktivieren Sie in den Source Track-
Schaltflächen die oberste Videospur. Es werden 
nur die ausgewählten und die darunter 
liegenden Videospuren aufgenommen.

15 Wenn Sie „Remote Mode“ ausgewählt haben, 
verwenden Sie die Record Track-Schaltflächen 
rechts, um die für die Aufnahme 
scharfzuschaltenden Audio- und Videospuren 
auszuwählen.

16 Klicken Sie auf die gelbe Preview-Schaltfläche, 
um zu prüfen, ob die ausgewählten Spuren 
wiedergegeben werden und die Insert-Punkte 
auf dem Band korrekt sind.

17 Sie haben folgende Möglichkeiten:

• Klicken Sie zur Aufnahme im Local Mode auf 
„Play“ und starten Sie die Aufnahme auf dem 
Videorekorder. Wenn Sie bereit sind, klicken 
Sie im Digital Cut-Fenster auf die Record-
Schaltfläche.

• Klicken Sie zur Aufnahme im Remote Mode 
im Digital Cut-Fenster auf „Record“. 
Media Composer fährt das Band an, startet die 
Wiedergabe und fügt das Material an der 
passenden Stelle ein.

Ausgewählte Ausgangsspuren

Source
Track- 
Schaltfläche

Record
Track-
Schaltfläche

Record Enable Preview

Wenn Sie eine digitale Ausspielung mit 
Avid Mojo DX oder Nitris DX durchführen, 
sollten Sie den Output-Modus auf „Real 
Time“ einstellen, sofern Sie einen anderen 
Videoausgang als FireWire nutzen, um die 
beste A/V-Synchronisierung zu gewährleisten.

Nehmen Sie mindestens ein paar Sekunden 
Schwarzfilm auf dem Band auf, bevor Sie eine 
digitale Ausspielung durchführen. Auf diese 
Weise ist das Videoband korrekt formatiert, 
wenn die digitale Ausspielung beginnt.
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9-Pin MachineControl (Einstellungen) 139

A
AAF

exportieren 367, 373
importieren 355
in Pro Tools öffnen 356
Metadaten 19, 1233
Umwandlungseinstellungen importieren 363
verknüpfte Medien 23

Abbrechen von Takes 458, 488
Abgestufter Parameter, Automation 1103
Abhören

Clips in der Clipliste 78, 276
Fades 627
in Browsern 305
MIDI-Noten 701
Pre-/Post-Roll 415
Programme 720
Start- und Endpunkte einer Selektion 415
Takes 472

Abhören von Audio
in Browsern 305

Absolute Grid-Modus 545, 859
ACID-Dateien 327

importieren 335
Add Key Change (Befehl) 831

Add Marker/Memory Location (Schaltfläche) 838
Add Meter Change-Schaltfläche 822
Add Tempo Change (Schaltfläche) 800, 819
Add Unique Triggers (Option) 688
Addieren

Trim-Automation 1112
VCA-Automation 1134

Adjust Session Start Time to Match Source Start 
Time 351

Advanced Meter Type-Einstellungen 122
AFL (After Fader Listen) 246
AFL/PFL Mutes (Output Path) 79
AFL/PFL-Pfad 79
After Fader Listen(AFL)-Modus 246
After Playback (Scrolling-Option) 413
After Write Pass, Switch To (Option) 119, 1074
AIFC-Dateiformat 365
AIFF-Dateiformat 1144
Akkorddiagramme 835
Akkorde 834
Akkordsymbole 775, 835
Aktiv 17

Inserts 1041
Spuren 249

Aktivieren
Auto Backup (Option) 110
Automation 1096
Gruppen 267
MIDI-Eingabegeräte 480
Plug-In-Automation 1051

Aktualisierungsrate 1312
Aktuelle Taktart (Anzeige) 183, 822
Aktuelles Tempo 183, 799
All MIDI Notes Off (Befehl) 725
Allow Latch Prime in Stop (Option) 118
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Allow Track Arm Commands in Local Mode 
(Option) 132

Alternate Takes-Popup-Menü 473, 659
Alternative übereinstimmende Takes 472, 659
Always Display Market Colors (Option) 107
Always Fill Channel Strips When Banking 

(Option) 117
Analysis-Darstellung 910, 924
Anforderungen von

QuickTime-Movies 1260
Anschluss-Setup 69
Ansichtsfilter (Memory Locations-Fenster) 848
Ansichtsfilter (MIDI Event-Liste) 780
Ansichts-Selektor des Mix-Fensters 991
Anzeige

alle Leisten 793
Originalzeitstempel 1227
Tempoleiste 799
User Time Stamp-Werte 1228

Anzeige aktiver Busse 99
Anzeige für Spurausgleich (cmp) 1027
Anzeigen

Clipnamen 534
Clipzeiten 534
Dateiinformationen für Audioclips 270
Meter-Leiste 822

Anzeigen von Blöcken in Videospuren 1264
Anzeigetyp 217
Anzeige-Voreinstellungen (Display) 105

Draw Grids in Edit Window (Option) 545
Apply Real-Time Properties (Option) 345
Archivieren von Sessions (mit Compact-Befehl) 621
ASIO 6
Assignments-Ansicht (Send-Ansichtsoption) 1002
Attribute (Gruppen) 264
Attributes (Befehl im Groups-Listen- 

Popup-Menü) 259
Audio During Fast Forward/Rewind (Option) 108, 

410
Audio Files (Ordner) 159
Audio Files Conform to Session 

Tempo-Schaltfläche 307
Audio Media Options 350
Audio Media Options

beim Import 360
Audio Pull Up/Down-Einstellung 1316
Audio Pull-Up und Edit Play Rate 1316
Audio Track RecordLock (Option) 111, 504
Audio Zoom In (Schaltfläche) 549

Audio Zoom Out (Schaltfläche) 549
Audiodateien 9

gemischte Dateitypen 166
importieren 326
komprimieren 621
Standardnamen 439

Audiodateiformate 158, 1144
Audioformat 376, 1205
Audio Media Options

beim Export 376
Audio-MIDI-Setup (AMS, Mac) 57, 145
Audio-Pull-Up und -Pull-Down 1213, 1315
Audiosignalpfade 70
Audiospuren 8

5.1-Format 1161
Audio in Mehrkanalspuren platzieren 1172
Ausgangsformate 1173
Bounce auf Festplatte 1141
Elastic Audio aktivieren 907
Elastic Audio deaktivieren 908
Kanalzüge 203
Loop-Aufnahme 470
mehrere aufnehmen 458
Punch-Aufnahme 465
Signalfluss 980
Spur-Steuerelemente 207
Surround-Sessions 1171
Tempo-Map erstellen 818
Waveform-Darstellung 526

AudioSuite (Fenster) 889
AudioSuite (Menü) 198
AudioSuite-Plug-Ins 889, 890, 897, 1039

Bypass (Schaltfläche) 895
Clip by Clip-Modus 892
Clip List (Befehl) 890
Create Continuous File (Befehl) 892
Create Individual Files (Befehl) 892
Default Handle Length (Voreinstellungen) 125
Entire Selection-Modus 892
File Mode-Selektor 892
Handle Length (Einstellung) 896
Mehrkanalbearbeitung 896
Overwrite File (Befehl) 892
Playlist (Befehl) 890
Preview 894
Preview Volume 895
Render (Schaltfläche) 896
Selection Reference-Selektor 890
Target (Schaltfläche) 893
Umkehren-Schaltfläche 895
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Use In Playlist (Schaltfläche) 891
verwenden 897
Whole File (Schaltfläche) 895

Audition Paths-Selektor 78
Auf Note warten 482
Auffinden

Playback-Cursor 408
Aufheben der Koppelung von 

Plug-In-Steuerelementen 1067, 1176
Aufnahme

auf System-Volume 448
aus digitaler Quelle 476
Bounce auf Festplatte 1141
destruktiv 468
in neuer Playlist 469
Instrumentenspuren 484
Loop Record 470
mehrere Audiospuren 458
Mehrkanalspuren 455
MIDI-Clips 487
MIDI-Spuren 484
mit halber Geschwindigkeit 478
mit Metronom 430
mit Round Robin-Zuweisung 446
mit Vorzählen 432
Mono-Audiospur 455
nichtdestruktiv 467
online 1217
QuickPunch-Modus 505
Record Pause-Modus 459
Spuren scharfschalten 442
Status-LED 507
Stereo-Audiospur 455
Submix auf Festplatte 1140
System Exklusive-Daten 494
Take rückgängig machen 457
Takes abbrechen 458
Tastenkombinationen 458
zusätzliche Takes 467

Aufnahmemodi 436
Destructive Record-Modus 437
Loop Record-Modus 437
MIDI 439
Nondestructive Record-Modus 436
QuickPunch 438

Aufnehmen 455
Aufrufen von Plug-In-Fenstern 1049
Aufzeichnung

Automation bis zum nächsten Breakpoint 1116
Snapshot-Automation 1124

Ausblenden
automatisch erzeugte Clips 279

Ausgänge
auf Mehrkanalspuren 1174
Format und Spuren 1173
mehrere Ausgänge zuweisen 996
Standard-Haupt- und Nebenpfade für 5.1 1165

Ausgeblendete Spuren
Gruppen 234
Gruppen editieren 234
Selektionen 578

Ausgleichen
Monitoring-Verzögerungen 1309, 1320
Video Satellite-Offsets 1309

Ausschneiden
Automation 1106
MIDI-Noten mit dem Split-Befehl 959
Selektionen und Clips 539

Aussetzen
Automation 1096
Automation schreiben 1096

Ausstehende Vorgänge 323
Austausch-Workflow

eingebettete Medien 22
verknüpfte Medien 23

Auswählen
Elemente in Browser 297

Ausweiten von Kanälen auf neue Playlists 662
Auto (Schaltfläche, Plug-Ins) 1047
Auto Backup (Option) 110
Auto Input-Monitoring-Modus 448, 449
Auto Match Pull Factors (Option) 1213
Auto Rename Clip List (Befehl) 278
AutoFades 636
AutoGlide Time (Voreinstellung) 119, 1193
AutoGlide-Modus 1193
AutoJoin

Anzeige 1076
Befehl 1075

AutoMatch
alle Steuerelemente 1092
Anzeigen 1084
einzelne Automationstypen 1092
einzelne Steuerelemente 1091
Schaltfläche 1091

AutoMatch Time (Voreinstellung) 118, 1080
Automatically Copy Files on Import 

(Option) 126, 337, 349
Automatically Create Click Track in New Sessions 

(Option) 129
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Automatically Find and Relink (Befehl) 387
Automation 1071

aktivieren 1096
auf ganze Selektion, zum Anfang oder Ende 

einer Selektion schreiben 1114
ausgeblendete Spuren 234
ausschneiden 1106
aussetzen 1096
bis zum nächsten Breakpoint schreiben 1116
Breakpoints 1104
Clip-Gain in Lautstärkeautomation 

umwandeln 619
Clip-Gain zu Lautstärkeautomation 

addieren 619
Clips 529
Delta-Werte 1077
Durchgangspunkt 1075
einfügen 1106
erfassen und an anderer Stelle anwenden 

1125, 1129
erstellen 1089
Fade-Grenzen und -Formen anzeigen 643
gestuft 1103
gruppierte Spuren 1106
kopieren 1106
Lautstärkeautomation in Clip-Gain 

umwandeln 619
Lautstärkeautomation zu Clip-Gain 

addieren 619
mehrfache Ausgangszuweisungen 1173
Mehrkanal-Pannen 1197
Mehrkanalspuren 1105
mit Pencil zeichnen 1100
Modi 1074
Playlists 645, 1072, 1081
relativ und absolut 1077
Safe (Schaltfläche) 1047
schreiben 1085
schreiben (On Stop-Modus) 1116
schützen 1081
Smoothing 1080
Snapshots 1123
Special Paste-Modus 1109
Spurdarstellung 538
Thinning 1080, 1099
Trim-Automation addieren 1112
trimmen 1112
VCA-Automation addieren 1134

Automation (Voreinstellungen)
Smooth and Thin Data After Pass (Option) 1099

Automation Follows Edit (Option) 1081
Automation Mode-Selektor 1074
Automation Preview-Modus 1127

aussetzen 1128
Punch Preview (Schaltfläche) 1128
Write Automation To (Befehle) 1129

Automation-Lanes
in MIDI Editor-Fenstern 753

Automationsaktivierungs-Fenster 1085
Automationsdaten

editieren 568, 1102
löschen 1098

Automations-Lanes 1082
im Edit-Fenster 1082

Automationsmodi
Latch 1075
Latch Trim 1078
Off 1074
Read 1074
Read Trim 1078
Touch 1075
Touch Trim 1078
Touch/Latch 1077
Touch/Latch Trim 1079
Trim Off 1078
Write 1074
Write Trim 1079

Automation-Voreinstellungen
AutoMatch Time 1080

Automatisch erzeugte Clips 525
ausblenden 279
umbenennen 277

Automatische Benennung
Audiodateien und -Clips 439
Playlists 645
QuickPunch-Clips 502
separierte Clips 601
Strip Silence 866
Takes 439

Automatisieren
Plug-Ins 1089, 1090
Schalter-Einstellungen 1086
Sends 1087
VCA Master 1132

Auto-Name Memory Locations While Playing 
(Option) 114, 839

Auto-Name Separated Clips (Option) 114, 601
Auto-Spot Clips (Befehl) 1226
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Auxiliary-Eingänge 14, 201
abhören und mischen 1015
Kanalzüge 204
Signalfluss 981
Spur-Steuerelemente 207

Avid Audio Engine (AAE) 6
Avid Audio Forums (Befehl) 188
Avid Video Engine (AVE) 57, 1259
Avid Video Satellite 1311

B
Back (Befehl) 410
Back and Play (Befehl) 410
Back/Forward (Befehle) 410
Back/Forward Amount 109
Backup von Sessions (automatisch) 110, 160
Bank Select 715
Bar|Beat-Marker

Audio mit Temposchwankungen 821
bearbeiten 821
Identify Beat (Befehl) 819
mit Beat Detective erzeugt 676
Tempo-Events 820
verschieben 820

Bars|Beats-Zeitskala 791
Batch Fades (Dialogfeld) 638
Bearbeiten

AudioSuite 896
Bar|Beat-Marker 821
Grid-Modi 859
Marker 844
mehrkanalig für AudioSuite 896
Memory Locations 844
Taktart-Events 823
Tempo-Events 800

Bearbeitungsbandbreite 66
Beat Detective 665, 666, 667

Bar|Beat-Marker erzeugen 676
Clips anpassen 681
Clips separieren 680
Collection-Modus 686
DigiGroove-Vorlagen 677
Edit Smoothing 685
Extrapolation 679
Fenster 667
Groove-Vorlagen 678
mehrere Spuren 681
Scroll Next 676
Selektion definieren 668
Signalspitzen erkennen 670

Systemanforderungen 666
Trigger Pad 680
Trigger-Punkte

einfügen 675
erzeugen 670
löschen 674
sperren 675
verschieben 674

Vorlagen 677
Bedienfelder

Delay Compensation 219
I/O-Bedienfeld 210
Inserts-Bedienfeld 993
Sends-Bedienfeld 993
Wide Meters (Bedienfeld) 215

Bedienoberflächen
C|24 1033
Command|8 1034
D-Command 1033
D-Control 1033

Befehls-Tastaturfokus 27
Beispiele für LCRS-Pfade 1166
Benutzerdefinierte Clips 277, 279, 525
Benutzerdefinierte Notendauer

Follow Grid 694
Benutzerdefinierte Session-Vorlagen 169
Benutzer-Standardvoreinstellung 1055
Benutzerzeitstempel 858, 1228
Berechnungseingabemodus für Zahleneingabe 583
Betriebs-Voreinstellungen (Operation) 108
Big Counter-Fenster 407
Bi-Phase/Tach

Impulse pro Frame (Einstellung) 137
Wiring (Einstellung) 137

Bitrate 157, 1204
Bittiefe 376
Blockdarstellung

Audiospur 226
Videospur 1264

Bounce to Disk (Befehl) 1137, 1141, 1143, 1156
Bit Depth (Optionen) 1148
Choose (Verzeichnis) 1153
Dither 1138
File Type 1144
Format 1147
im Output Path-Selektor 1143
im Send Path-Selektor 1143
Kanalformatoptionen 1147
Offline (Option) 1153
Quellpfad 1143
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Samplerate-Konvertierungsoptionen 1148
Samplerate-Konvertierungs-Qualität 1149
Share With SoundCloud (Option) 1150
Submix aufnehmen 1155
Zeitstempel 1142

Bounce to QuickTime Movie (Befehl) 1289
Breakpoints 1104

Avid-Keyframes 1102
Clip-Gain 614

Bring to Front (Befehl im Clip-Menü) 603
Browser 284

Anzeigeoptionen 292
öffnen 285
sortieren 293

Busabfrage 1008
Bus-Funktionen

Beispiele für Surround 1180
Sends 998
Signalpfade 69

Busse
Mehrkanal-Sends 1175
Submixe und Effektbearbeitung 1014

BWF (.WAV)-Dateiformat 1144
Bypass (Schaltfläche, Plug-Ins) 1048

C
C|24 49
Cache-Größe 57
Calibration Mode (Befehl) 430
Calibration Reference Level (Voreinstellung) 113
Capture Clip (Befehl) 599
Center% (Percentage) 1194
Center-Prozentsatz im Output-Fenster 1195
Change Duration (Befehl) 935, 954
Change Edit to Match Timeline (Befehl) 589
Change Meter (Befehl) 774, 822, 824, 825
Change Tempo (Befehl) 800
Change Timeline to Match Edit (Befehl) 589
Change Velocity (Befehl) 935, 952
Channel-Selektor 1049

Multimono-Plug-Ins 1176
Chasing

MIDI-Controller-Events 722
MIDI-Noten 722
MIDI-Programmwechsel 722

Check For Updates (Befehl) 50
Chord Change-Dialogfeld 835
Chord Symbols-Leiste 834
Classic-Ziffernblockmodus 29, 109
Clear (Löschbefehl im Clipliste-Menü) 279, 280

Clear (Löschbefehl im Edit-Menü) 540
Clear All Clip Indicators (Befehl) 213, 214, 1005
Clear Clip Gain (Befehl) 617
Clear Special (Automationsbefehle) 1109
Clear Trim Automation (Spurbefehl) 235, 1099
Click-Plug-In 431
Clip (Menü) 198

Bring to Front (Befehl) 603
Capture (Befehl) 599
Identify Sync Point (Befehl) 1228
Lock (Befehl) 864
Mute/Unmute (Befehl) 866
Quantize to Grid (Befehl) 609
Remove Sync Point (Befehl) 863
Send to Back (Befehl) 603
Ungroup All Clips (Befehl) 879
Ungroup Clips (Befehl) 879
Unlock (Befehl) 864
Unloop Clips (Befehl) 875

Clip Auto Fade In/Out Length (Voreinstellung) 637
Clip ersetzen-Befehl 280, 860
Clip Groups-Ordner 159
Clip Hold (Optionen) 123, 214
Clip Info-Dialogfeld 1319
Clip List (Menü)

Export Selected As Files (Befehl) 372
Clip List Selection Follows Edit Selection 

(Option) 114, 270, 579
Clip Time View (Option) 534
Clipbasierter Gain 363, 611
Clip-Darstellung 225, 227
Clipdefinitionen 342
Clip-Gain 611

auf Bypass schalten 620
ausschneiden 617
bearbeiten 613
Breakpoints bearbeiten 614
Clip-Gain in Lautstärkeautomation 

umwandeln 619
Clip-Gain zu Lautstärkeautomation 

addieren 619
Clip-Gain-Info (Anzeige) 612
Clip-Gain-Linie 613
Clipgruppen 885
Default Handle Length (Voreinstellungen) 125
dynamisch 612
einfügen 618
kopieren 618
Lautstärkeautomation in Clip-Gain 

umwandeln 619
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Lautstärkeautomation zu Clip-Gain addieren 619
löschen 617
mit dem Clip-Gain-Fader anpassen 614
mit dem Grabber-Tool bearbeiten 614
mit dem Pencil-Tool bearbeiten 615
rendern 620
statisch 612
statischen Clip-Gain-Wert anzeigen 612

Clip-Gain auf Bypass schalten (Einstellung) 620
Clip-Gain-Fader 614
Clip-Gain-Fader-Symbol 612
Clip-Gain-Info (Anzeige) 612
Clip-Gain-Linie 613
Clip-Grenzen

Selektionen erweitern 582
Clipgrenzen

Edit-Cursor verschieben 585
Playhead verschieben 417

Clipgruppen 525, 877
auf andere Festplatte exportieren 384
auflösen 879
editieren 883
erstellen 878
Fades und Crossfades 884
gemischt 880
importieren 382
importieren und exportieren 381
Multitrack 880
separiert 881
Tick-basiert 882
trimmen 883
Video 1282
wiederherstellen 879
Zeitbasis-Format 878, 882

Clipgruppen-Dateiformat (.rgrp) 381, 885
Clipliste 269

Clips abhören 276
Clips auswählen 274
Clips suchen 272
Clips vorhören 276
daraus ziehen 849
Dateiinformationen für Audioclips 

anzeigen 270
Export Clips As Files (Befehl) 340
MIDI-Clips 269
Popup-Menü 269
sortieren 271
Suchverlauf 273
Tastaturfokus 27
vorherige Suche wiederholen 273

Clipliste (Menü) 1227
Cliplisten-Menü

Auto Rename (Befehl) 278
Clear (Befehl) 279
Compact (Befehl) 621
Export Clip Definitions (Befehl) 342
Find (Befehl) 272
Rename (Befehl) 278
Select (Optionen) 275
Select Unused (Optionen) 279
Show Auto-Created (Option) 279
Sort by (Optionen) 271
Time Stamp Selected (Befehl) 858
Timeline Drop Order (Option) 850

Cliplisten-Tastaturfokus 275
Clipname

Kontextmenü 199, 280
View (Option) 534

clipping 428
Clips 10, 226, 526

alle auf einer Spur selektieren 578
als Audiodateien exportieren 340
am Edit-Einfügepunkt platzieren 851
am nächsten ausrichten 855
am Startpunkt anderer Clips ausrichten 852
an Edit-Selektion anpassen 622
auf Mehrkanalspuren ziehen 611
aus Clipliste ziehen 849
ausrichten 855
ausschneiden 539
Automation 529
automatisch erzeugt 525
automatisch erzeugte ausblenden 279
automatisch platzieren 1226
benutzerdefiniert 277, 279, 525
Clips mit Fades über die Nudge-Funktion 

verschieben 639
Clips mit Fades verschieben 639
Conform to Tempo 804
Crossfades zwischen Clips 635
duplizieren 870
Echtzeiteigenschaften löschen 732
Edit Lock 864
einfügen 540
erfassen 599
ersetzen 860
erstellen 599
Gain 611
gewarpt (Elastic Audio) 923
im Grid-Modus verschieben 859
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im Slip-Modus verschieben 856
im Spot-Modus platzieren 857, 1225
in den Hintergund 603
in den Vordergrund 603
in der Clipliste umbenennen 278
in einer Spur umbenennen 533
in Spuren platzieren 849
konsolidieren 621
kopieren 539
Loops 873
löschen 540
Mehrkanal 525
MIDI 487
mit Beat Detective anpassen 681
mit Beat Detective separieren 680
mit Separation Grabber trennen 602
Namen anzeigen 534
nicht benötigte Daten trimmen 604
nicht genutzte entfernen 279
Nudge-Funktion 608
offline 525
Optionen zur automatischen Benennung 278
Original Time Stamp 858
quantisieren 609, 949
Select (Optionen) 275
selektieren 565, 578
Selektionen um angrenzende erweitern 582
sortieren 271
Sperre aufheben 864
sperren 864
Standardnamen 439
Start- und Endpunkte trimmen 559
stille Passagen einfügen 869
stille Passagen entfernen 867
stille Passagen entfernen (Strip Silence) 866
stummschalten 866
suchen 272
Sync-Punkte 862, 1228
Time Lock 865
Tonhöhenänderung rückgängig machen 

(Elastic Audio) 931
trennen 600
Trennung zusammenfügen 604
um Nudge-Wert trimmen 606, 705
User Time Stamp 858
verformt (Elastic Audio) 525
verschieben 853, 854, 864
versetzen 853
verwalten 277
Video 1278

Warping entfernen (Elastic Audio) 924
Whole-File 525
wiederholen 871
Zeiten anzeigen 534
Zeitstempel 1226
zum Edit-Einfügepunkt trimmen 604

Clips-Darstellung 530
Clock Reference (Einstellung) 1315
Close Session (Befehl) 170
Coalesce Clip Gain to Volume Automation 

(Befehl) 619
Coalesce Trim Automation (Optionen) 119
Coalesce Trim Automation (Spurbefehl) 235
Coalesce VCA Master Automation (Spurbefehl) 235
Coalesce Volume to Clip Gain (Befehl) 619
Coalesce when Removing Slaves from VCA Group 

(Option) 118
Collection-Modus (Beat Detective) 686
Color Coding

Optionen 107, 250
Command|8 49, 1034
Comments-Bedienfeld 222, 992
Compact (Befehl) 621
Compact Selected (Befehl) 280
Compare (Schaltfläche, Plug-Ins) 1047
Compensation for Input Delays After Record Pass 

(Option) 77
Compensation for Output Delays After Record Pass 

(Option) 77
Compositing 648
Conform to Tempo (Befehl) 804
Consolidate (Befehl)

Audio 621
MIDI-Noten 707

Consolidate From Source Media 376
Consolidate Handle Length 361, 376
Consolidate Handle Size 376
Consolidate Source Audio Media (Option) 360
Constant (Befehl im Tempo Operations-Fenster) 813
Continuous Scroll with Playhead (Option) 414
Continuous Scrolling During Playback 

(Scrolling-Option) 414
Controller Meter Path-Selektor 77
Controller-Events 712

editieren 713
einfügen 713
MIDI-Clips 531
mit Smart-Tool editieren 568

Controller-Lanes 712, 1082
im Edit-Fenster 1082
in MIDI Editor-Fenstern 753
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Controllers-Ordner (Personality-Dateien für 
Controller) 1034

Conversion Quality (Option) 327, 1149, 1277
Convert Clip Gain to Volume Automation 

(Befehl) 619
Convert Plug-In-Selektor 1048
Convert Volume to Clip Gain (Befehl) 619
Convert WAV files to AES31/BroadcastWave 

(Option) 126, 337, 388
Copy (Befehl) 539
Copy Clip Gain (Befehl) 618
Copy From Source Media 376
Copy from Source Media (Video) 351, 361
Copy Settings (Befehl) 1053
Copy Source Audio Media (Option) 360
Copy Special (Befehle) 1109
Copy to Send (Befehl) 1088
Core Audio 6
Countoff (Schaltfläche) 183
Create Click Track (Befehl) 431
Create Fades (Befehl) 635, 636
Crossfade Preview Pre/Post-Roll (Option) 114, 632
Crossfades

Batch-Funktion 637
DestructivePunch 503
entfernen 635
Equal Gain 630
Equal Power 630, 632
Fades (Dialogfeld) 627
linear 631
mit Smart-Tool erstellen 567
Pre/Post 636
TrackPunch 503
trimmen 635
überlappend 632
Waveform-Überlappungs-Ansicht 627

Current Feet+Frames (Befehl) 1211
Current Time (Anzeige) 1205
Current Timecode Position (Befehl) 1211
Custom FF/REW Speed (Voreinstellung) 109
Custom Shuttle Lock Speed 

(Voreinstellung) 109, 571
Cut (Befehl) 539
Cut Clip Gain (Befehl) 617
Cut Special (Befehle) 1108

All Automation 1108
Pan Automation 1108
Plug-In Automation 1108

Cut Time (Befehl) 824, 828

D
Darstellungshöhe

Größe ändern 231
Dateiformate für Audio

AIFF 1144
BWF (WAV) 1144
MP3 1145
MXF 1146
QuickTime 1146

Dateiverwaltung 385
DAT-Rekorder, Aufnahme 477
Dauer von MIDI-Noten

mehr legato 956
mehr staccato 956
mit Change Duration-Befehl editieren 954
zufällig 956

D-Command 49, 1033
D-Control 49, 1033
Default Automatic Naming to English (Option) 106
Default Clip Color Coding-Optionen 107
Default Dynamics (Voreinstellung) 116, 1044
Default EQ (Voreinstellung) 116, 1044
Default Handle Length (Optionen) 125
Default Input Gain (Voreinstellung) 127
Default Monitor Format-Selektor 80
Default Note Duration 693
Default Note On Velocity (Einstellung) 694
Default Plug-In (Voreinstellung) 127
Default Thru Instrument 481
Default Thru Instrument (Voreinstellung) 129
Default Track Color Coding-Optionen 107
Degree of Thinning (Voreinstellung) 117
Delay After Play Command (Voreinstellung) 132
Delay Before Locking to LTC (Option) 131
Delay Before Locking to Timecode (Option) 131
Delay Compensation 1024

aktivieren 1024
anzeigen 219, 994
auf automatisch auf Bypass geschaltete 

Spuren anwenden 1028
auf Bypass schalten 1027
Delay-Anzeige (dly) 1026
Hardware-Insert-Delays 1031
MIDI Beat Clock 130
MIDI Timecode 130
Modus 1025
Spurverzögerung ändern 1026
Time Mode (Option) 113
User Offset (+/–, Feld) 1026
Verzögerungsausgleichsgrenze 

überschreiten 1027
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Delay Compensation Time Mode (Option) 113, 1025
Delay Compensation View (Option) 1025
Delay Compensation-Bedienfeld 219, 994, 1025
Delay for External Devices (Optionen) 130
Delay-Anzeige (dly) 1026
Delay-Einstellung (Real-Time Properties) 730
Delay-Plug-Ins 1037
Delete (Gruppenbefehl) 259, 263
Delete Active Groups (Befehl im 

Groups-Listen-Popup-Menü) 258, 264
Delete Current Settings File (Befehl) 1053
Delete Fades (Befehl) 635
Delete Track (Befehl) 224, 235
Destination Audio Sample Rate 375
Destructive Record-Modus 437, 468
DestructivePunch 512

Audiodatei vorbereiten 513
Crossfades 503
Prepare DPE Tracks (Befehl) 514

DestructivePunch File Length 
(Voreinstellung) 112, 513

Destruktive Aufnahme 468
Destruktives Editieren 621
DigiGroove-Vorlagen 677
Digital Cut Tool (Media Composer) 1326
DigiTest 52
Dirigent (Schaltfläche) 183
Dirigentenleisten 793

in Selektionen einschließen 584
Disable “Input” When Disarming Track (In “Stop”) 

(Option) 111
Disk Allocation 446

System-Volume 448
Disk Usage-Fenster 445
Display (Befehl im Groups-Listen-Popup-Menü) 258
Display Events as Modified by Real-Time 

Properties (Option) 128, 733
Display-Voreinstellungen

Clip Hold (Optionen) 123
Peak Hold (Optionen) 123
Sprachoptionen 106

Dither
auf Master-Fadern 1139
Auflösung und Bounce to Disk 1148
Bounce to Disk 1138

Divergenz
verwenden 1194
zeichnen 1195

Double-Clicking a MIDI Clip Opens (Option) 129
Drag and Drop From Desktop Conforms to Session 

Tempo (Optionen) 126, 338
Drag & Drop

Audiodateien importieren 329
aus Clipliste in Spuren 850, 851
MIDI-Dateien importieren 344

Draw Grids in Edit Window (Option) 545
DSP

aktive und inaktive Elemente 17
Gesamtressourcen 16
inaktive Ausgänge 997
inaktive Ein- und Ausgänge 239
inaktive Sends 1005
kein Ausgang 997
Send-Pegelanzeige 1004

DSP-Auslastung (Anzeige) 67
Dubber-Emulation 111, 504
Duplicate (Befehl) 870
Duplicate (Gruppenbefehl) 259
Duplicate Track (Befehl) 224, 235, 1074
Duplizieren

Inserts 1045
MIDI-Noten-Selektionen 871
Playlists 646
Selektionen und Clips 870
Sends 1006

Duration
Real-Time Properties 729

Durchgangspunkt 1075
Dynamic Plug-In Processing (Option) 56
Dynamic Transport-Modus 419
Dynamik-Plug-Ins 1037

E
Echtzeit-Eigenschaften

aktivieren 728
ansehen 726
Display Events as Modified by Real-Time 

Properties 128
in MIDI Event-Liste 733
löschen 732

Echtzeit-Plug-Ins 1037
Edit (Befehle) 537, 539, 540
Edit (Fenster)

All (Ansichtsoption) 992
Ansichtsoptionen 175
mit Leiste scrollen 590
None (Ansichtsoption) 992
Universe-Darstellung 592
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Edit (Menü)
Change Edit to Match Timeline (Befehl) 589
Change Timeline to Match Edit (Befehl) 589
Clear (Befehl) 540
Clear Special (Befehle) 1109
Consolidate (Befehl) 621
Copy (Befehl) 539
Create Fades (Befehl) 635, 636
Cut (Befehl) 539
Delete Fades (Befehl) 635
Duplicate (Befehl) 870
Fade To End (Befehl) 634
Fade to Start (Befehl) 634
Fades (Befehl) 627
Heal Separation (Befehl) 604
Identify Sync Point (Befehl) 862
Insert Silence (Befehl) 869
Paste (Befehl) 540
Play Edit Selection (Befehl) 417
Play Timeline Selection (Befehl) 417
Redo (Befehl) 535
Repeat (Befehl) 871
Repeat to Fill Selection (Befehl) 541
Separate Clip (Befehle) 600
Shift (Befehl) 864
Strip Silence (Befehl) 866, 867
TCE Edit to Timeline Selection (Befehl) 622
Trim Automation to All Enabled (Befehl) 1126
Trim Automation to Current (Befehl) 1126
Trim Clip End to Fill Selection (Befehl) 605
Trim Clip End to Insertion (Befehl) 605
Trim Clip Start to Fill Selection (Befehl) 605
Trim Clip Start to Insertion (Befehl) 604
Trim Clip to Fill Selection (Befehl) 606
Trim Clip to Selection (Befehl) 604
Undo (Befehl) 535
Write Automation (Befehle) 1124, 1125

Edit (Menü)
Select all (Befehl) 578

Edit Insertion Follows Scrub/Shuttle 
(Option) 108, 569

Edit Lock für Clips 864
Edit Play Rate (Einstellung) 1315, 1316
Edit Selection Follows Clip List Selection 

(Option) 114, 579
Edit Smoothing (Beat Detective) 685
Edit Window Default Length (Voreinstellung) 106, 

179
Edit Window Follows Bank Selection (Option) 117
Edit/Tool Mode Keyboard Lock 573

Edit-Cursor 408
an Clip-Grenzen verschieben 585
mit Selector-Tool platzieren 565
Scrubben 569

Edit-Einfügepunkt
Clips platzieren 851
Clips trimmen 604

Edit-Fenster 173, 174, 175
halb 414

Edit-Fenster (Ansichtsoptionen) 992
Edit-Fenster-Ansicht-Selektor 991
Edit-Gruppen 261

Selektionen 577
Editieren

ausgeblendete Spuren 234
Automationsdaten 1102
Breakpoints 1104
Controller-Events 713
Edit-Modi 543
in MIDI Event-Liste 785
MIDI-Clips 530
MIDI-Noten 700
nicht destruktiv 523
nicht destruktiv (Audio) 529
nicht destruktiv (MIDI) 533
Notenattribute 709
Notendauer 954
Programmwechsel 719
Shuffle (Modus) 543
Spurdarstellung 538
über mehrere Spuren hinweg 542
Velocity-Werte 707, 952
während der Wiedergabe 524
Wellenformen 528

Editing
Edit-Modi 543
Grid (Modus) 545, 546, 547
Shuffle Lock (Modus) 544
Slip (Modus) 544
Spot (Modus) 544

Editing-Voreinstellungen 114
Auto-Name Memory Locations While Playing 

(Option) 839
Auto-Name Separated Clips (Option) 601
Clip List Selection Follows Edit Selection 

(Option) 270, 579
Conversion Quality (Option) 327
Crossfade Preference for Pre/Post-Roll 

(Option) 114, 632
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Edit Selection Follows Clip List Selection 
(Option) 579

QuickPunch Crossfade Length 
(Voreinstellung) 503

Separate Clip Operates On All Related Takes 
(Option) 601

Edit-Marker 576
Länge von Selektionen 581

Edit-Menü 197
Copy Special (Automationsbefehle) 1109
Copy To Send (Befehl) 1088
Cut Special (Befehle) 1108
Thin All Automation (Befehl) 1100
Thin Automation (Befehl) 1100

Edit-Modi 543
Clips platzieren 849
Grid 545
Relative Grid 545
Shuffle 543
Shuffle Lock 544
Slip 544
Spot 544, 1223

Edit-Modi-Schaltflächen 175
Edit-Modus-Schaltflächen 543
Edit-Playlists 645
Edit-Selektionen

auf der Leiste verschieben 586
aus Timeline-Selektion kopieren 589
bei aktiviertem Playhead wiedergeben 417
in Timeline-Selektion kopieren 589
mittels Selector-Tool 565

Edit-Selektions-Anzeigen 583
Edit-Tools 547

Grabber 547, 580
Pencil 547, 572
Scrubber 547, 569
Selector 409, 547
Smart-Tool 547
Trim 547, 559
Zoomer 547, 548

Effect Bypass-Schaltfläche 1048
Einblenden/Ausblenden der Clipliste 

(Schaltfläche) 269
Einblenden/Ausblenden der Tracks in Gruppe 

(Befehl) 259
Einblenden/Ausblenden der 

Tracks-Liste/Groups-Liste 
(Schaltfläche) 232, 258

Einfüge am nächsten oder vorherigen Clip 855
Einfügen

Automation 1109
Controller-Events 713
Events in MIDI Event-Liste 782
in mehrere Spuren 542
mehrere Datentypen 542
MIDI-Noten 698
mit Repeat to Fill Selection (Befehl) 541
Plug-In-Einstellungen 1055
Programmwechsel 719
Selektionen und Clips 540
Taktart-Events 822
Tempo-Events 800

Eingangsanschlüsse 11, 428
Eingangspegel 428
Eingeben von Tempo mit Tap-Funktion 435
eingebettete Medien 22
Einschleifen

Plug-Ins auf Spuren 1042
Einstellen

Startzeit-Offset für Satellite-Systeme 1309
Einstellungen

einfügen 1055
erstellen 1055
kopieren 1055
Settings Preferences (Befehl) 1054
speichern 1055
Speicherort auswählen 1054
Unterordner erstellen 1054

Elastic Audio 901
Akkordeon-Warp 921
Analyse 910
Analyse in Workspace 304
Analysis-Darstellung 910, 924
AudioSuite-Bearbeitung 931
auf Spuren aktivieren 907
Batch-Analyse 304
Bearbeitung außerhalb des gültigen 

Bereichs 923
Bearbeitungstypen 912
Bereichs-Warp 921
Clips zwischen Spuren verschieben 932
Conform to Tempo 804
deaktivieren 908
Edit-Gruppen 924
Eigenschaften 926
einzelner Bereichs-Warp 922
Event-Marker 918
Event-Marker hinzufügen 925
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Event-Marker löschen 926
Event-Marker sperren 926
Event-Marker verschieben 925
Event-Zuverlässigkeit 911
gerenderte Dateien 912

neu generieren 313, 387
gewarpte Clips 923
Monophonic-Plug-In 916
neue Spuren erstellen 908
Pitch Shift 930
Plug-Ins 913
Plug-In-Selektor in Browsern 307
Polyphonic-Plug-In 914
quantisieren 948
Rhythmic-Plug-In 915
speichern 908
Spurdarstellungen 909
Spuren 907
Steuerelemente für Spuren 909
TCE-Algorithmus 913
Teleskop-Warp 920
tempobasiertes Warping 804
Tempoerfassung 910
Tempo-Event-generierte Warp-Marker 919
transponieren 930
Übersteuerungsanzeige 913
Varispeed-Plug-In 916
Vorhören im Session-Tempo 309
Warp-Anzeige 923
Warp-Darstellung 909, 917
Warping entfernen 924
Warp-Marker 918
X-Form-Plug-In 916

Elastic Audio
Workflows 901, 902

Elastic Audio-fähige Spuren 907
Elastic Audio-Plug-In-Selektor 909
Elastic Audio-Voreinstellungen 127
Elastic Properties-Fenster 926
Eleven Rack 41
Embed Eleven Setting From-Selektor 81
Enable Dub Window (Option) 137
Enable Elastic Audio on New Tracks 

(Voreinstellung) 127
Enable GPU (Option) 110
Enable Hardware During Scrub (Option) 110
Enable Session File Auto Backup (Option) 110
Enable SYNC Peripheral (Option) 136
End To Insertion (Befehl) 605
Endgültiger Mixdown 1156

Enforce Avid Compatibility (Option) 373
Enforce Mac/PC Compatibility (Option) 167, 391
Entfernen

Crossfades 635
Plug-Ins aus Spuren 1042
Sends 999

Entkoppelte Timeline- und Edit-Selektion 575
EQ-Plug-Ins 1037
Equal Gain-Crossfades 630
Equal Power-Crossfades 630, 632
Erfassen von Automationswerten 1129
Erfassen von Timecode 1225
error suppression 55
Erstellen

Clipgruppen 878
Clips 599
Crossfades 635
Fade-Ins/-Outs 633
Mac- and PC-kompatible Sessions 391
Marker und Memory Locations 837
Sessions 156
Unterordner für Einstellungen 1054

Erweitern von Selektionen 582, 809
auf angrenzende Spuren 584, 585
auf Clip-Grenzen 582
auf Marker und Memory Locations 582
um angrenzende Clips 582

Erweiterte Transport-Darstellung 195, 461
Erweitertes Metering 216
Erzeugen von Timecode 1217
Ethernet Controllers 141
EUCON 141, 1033, 1071
Event (Menü) 198

All MIDI Notes Off (Befehl) 725
Beat Detective (Befehl) 667
Change Meter (Befehl) 822
Event-Befehle 935
Identify Beat (Befehl) 818
MIDI Event-Liste 779
MIDI Track Offsets (Befehl) 724
MIDI-Befehle 935
Remove Duplicate Notes (Befehl) 725
Renumber Bars (Befehl) 830
Tempo (Befehle) 812
Time (Befehle) 824

Event Edit-Bereich 709
Event Operations (Befehle) 935

Change Duration (Befehl) 954
Change Velocity (Befehl) 952
Flatten Performance (Befehl) 951
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Input Quantize (Befehl) 961
Quantize (Befehl) 937
Restore Performance (Befehl) 950
Select/Split Notes (Befehl) 960
Step Input (Befehl) 962
Transpose (Befehl) 956

Event Operations (Fenster) 935, 936
Exit (Windows-Befehl) 170
Expand to New Tracks (Befehl) 235
Export

AAF-Dateien 367, 376
Audio 340
Audio Media Options 376
Clipdefinitionen 342
Clipgruppen 383
Interleaved-Stereodateien 341
Marker 345
MIDI-Spuren 344
OMF/AAF (Optionen) 373
OMF-Dateien 376
OMFI-Dateien 367
Sample Rate Conversion Options 375
Sessions als Text 379

Export Clip Definitions (Befehl) 280, 342
Export Clip Groups (Befehl) 383
Export Clips As Files (Befehl) 280, 340
Export MIDI (Befehl) 344
Export MIDI Settings (Dialogfeld)

Apply Real-Time Properties (Option) 345
MIDI File Format (Popup-Menü) 344

Export Selected As Files (Befehl) 372
Export Selected Tracks as OMF/AAF 

(Befehl) 367, 369
Export Session Info as Text (Befehl) 379
Export Settings (Schaltfläche im I/O 

Setup-Dialogfeld) 102
Exportieren

Partitur nach Sibelius 776
Sibelius-Dateien (.sib) 776

Exportieren 325
Ext. Clock-Ausgang 62, 1202
External Timecode Offsets 1207
Externe MIDI-Instrumente 497
Externe Sidechain-Bearbeitung 1052
Externer Taktgeber 1069
Extrapolation 679

F
Fade Files (Ordner) 159
Fade To End (Befehl) 634
Fade To Start (Befehl) 634
Fade-In-Kurvenformen 630
Fade-Out-Kurvenformen 629
Fades 633

AutoFades 636
Batch-Funktion 637
erzeugen 633
mit Smart-Tool erstellen 567
Nudge-Funktion 638
verschieben 638

Fades (Befehl) 627
Fades (Dialogfeld) 627

In Shape 630
Link (Option) 630
Out Shape 629

Fade-Standardeinstellungen 115
Farbeinstellung (für Timecode-Markierung) 137
Farbliche Kennzeichnung

auf Kanalzug anwenden 253
Farbpalette 252
Fast Forward (Schaltfläche) 180
Feet+Frames

Position neu festlegen 1211
Feet+Frames Rate (Einstellung) 1205
Feet+Frames-Zeitskala 792
Fehlende Dateien 387

auslassen 313
Fenster

alle unverankerten ausblenden 192
anordnen 192
Cascade 192
schließen 193
Tile 192
Tile Horizontal 192
Tile Vertical 192

Fensterkonfigurationen 189
importieren 354

Fensterkonfigurationsliste 194
Festplatten

Audio komprimieren 621
auf System-Volume aufnehmen 448
Round Robin-Zuweisung 446

Festplattenzuweisung
plattformübergreifende Sessions 447
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File (Menü) 197
Bounce to Disk (Befehl) 1141
Close Session (Befehl) 170
Exit (Windows-Befehl) 170
Export MIDI (Befehl) 344
Export Selected Tracks as OMF/AAF 

(Befehl) 367
Export Session Info as Text (Befehl) 379
Import Audio to Track (Befehl) 332
Import Clip Groups (Befehl) 382
Open Session (Befehl) 160
Revert to Saved (Befehl) 163
Save (Befehl) 163
Save As (Befehl) 164
Save Copy In (Befehl) 164, 392
Send To Gobbler (Befehl) 384

Find All Candidates (Befehl) 315
Find Clip List (Befehl) 272
Find Matching Tracks (Option) 352
First Selected MIDI Track (Option) 129
Flatten Performance (Befehl) 935, 951
Force Audio Media to Target Session Format 

(Option) 361
Forward (Befehl) 410
Forward and Play (Befehl) 410
Framedarstellung 1264
Framedarstellung (Videospuren) 1264
Framerate

Aktualisierungsrate 1312
Pull-Up und Pull-Down 1213

Frame-Tearing 1313
Freewheel für Timecode 1209
Front Divergence 1194
Front/Rear Divergence 1194
Fußschalter 61

G
Gain Reduction-Anzeige 217
Gemischte Bitrates 166
Gemischte Dateitypen 166
Gitarrentabulatur 835
Gleichgerichtete Darstellung 527
Glide Automation (Befehle) 1110
Global MIDI Playback Offset 

(Voreinstellung) 129, 723
Globale (systemweite) Voreinstellungen 133
Go to End (Schaltfläche) 180
Gobbler 384, 1152
Grabber-Tools 547, 566, 580, 703

Breakpoints bearbeiten 808, 1102

Clip-Gain-Breakpoints bearbeiten 614
MIDI-Noten selektieren 700
Object Grabber-Tool 566, 580
Separation Grabber-Tool 566, 602
Time Grabber-Tool 566

Grid (Modus)
absolut 545
Clips/Markers (Option) 547
Draw Grids in Edit Window (Option) 545
konfigurieren 546
relativ 545

Grid Value-Selektor 546
Grid-Modus

Absolute 859
aktivierter Slip-, Shuffle- oder Spot-Modus 546
aussetzen 859
Rasterwert festlegen 859
Relative 859

Grid-Modus (Raster-Modus) 545, 859
Groove Quantize 943
Groove-Vorlagen 677, 678, 943

anwenden 946
zuordnen 947

Größeneinstellung (für Timecode-Markierung) 137
Group (Dialogfeld) 260
Group Assignment-Selektor 985
Group Track (Befehl) 261
Groups-Liste

Popup-Menü 258
Gruppen

aktivieren 267
ändern 262
Attribute 264
ausgeblendete Spuren 234
Automationsdaten editieren 1106
duplizieren 264
Edit-Gruppen 261
erstellen 261
Kopplung von Mix- und Edit-Gruppen 

aufheben 257
löschen 263
Mix- und Edit-Gruppen koppeln 256
Mix-Gruppen 261
Steuerelement-Offsets 268
über die Tastatur auswählen 267
umbenennen 262

Gruppen-ID (Anzeige) 259
Gruppenliste 257

Tastaturfokus 27
Gruppenname 259
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H
H/W Insert Delay 75
Halbe Geschwindigkeit, Aufnahme mit 478
Halbe Geschwindigkeit, Wiedergabe 418
Halbes Fenster 414
Hardware Buffer Size 52, 54
Hardware Setup

Ext. Clock-Ausgang 62
Launch Setup App 59

Hardware-I/O-Inserts 1038
Delays 75

Hardware-I/O-Sends 1002
Hardware-Insert-Verzögerungsausgleich 75, 1031
Hardware-Puffergröße 451
Hardware-Setup

Puffergröße 451
Hauptpfade 70
Hauptzähler (Main) 794
Haupt-Zeitskala 794, 1212
HD-Audio-Interfaces 44
HDI/O 48
HDMADI 49
HDNative-Systeme 43
HDOMNI 47, 64
HDX-Systeme 42
Heal Separation (Befehl) 604
HEAT 50, 967

Master-Einstellungen importieren 355
Help (Menü) 25, 198
HFS+-Laufwerke

Windows-Systeme 389
Hide All Floating Windows (Befehl) 192
Hide and Make Inactive (Spurbefehl) 235
Hide/Show (Spurbefehl) 235
High-Definition-Video

Wiedergabe 1286, 1312
Hilfe 198

QuickInfos 106, 199
Horizontal Position (Einstellung) 137
Horizontal Zoom In (Schaltfläche) 548
Horizontal Zoom Out (Schaltfläche) 548
Host Engine 54

I
I/O Setup

Bus (Registerkarte) 73
Einstellungsdateien 100
für Surround importieren 1165
Input (Registerkarte) 72

Insert (Registerkarte) 74
Nebenpfade 90
nicht verfügbare Ein-/Ausgänge 104
Output (Registerkarte) 73
Surround 1180
Surround Mix-Einstellungsdateien 100
Surround-Formate 1163
werkseitige Einstellungsdateien 100
zuletzt verwendet 102

I/O-Bedienfeld 210, 994
I/O-Einstellungen 100
I/O-Setup

anpassen 82
Dialogfeld 70
Hardware-Insert Delay (Registerkarte) 75
I/O-Routing 83
Mikrofonvorverstärker 74
Niedriglatenz-Monitoring 80
Optionen 77
Pfade 87
Steuerelemente 75

Identify Beat (Befehl) 818, 819
Identify Sync Point (Befehl) 862, 1228
Idle MTC Enabled (Option) 136
Ignore Errors During Playback/Record (Option) 55
Ignore Track Arming (Option) 132
Import

Audio 326
Audio Media Options 360
auf importierte Dateien verweisen 348
Clipgruppen 382
Drag& Drop 329
Fensterkonfigurationen 354
HEAT Master-Einstellungen 355
importierte Dateien kopieren 348
Key Signature Map 354
kopieren 349
Marker 343, 354
Mehrkanal-Audiodateien von einem tragbaren 

Rekorder 336
Mehrkanal-I/O-Einstellungen 1165
Memory Locations 354
MIDI-Spuren 342
Offline-Elemente aus einem Katalog 320
Plug-In-Einstellungen 1055
PRE-Einstellungen 354
Sample Rate Conversion Options 362
Session-Daten 349
Spuren aus anderen Sessions 346
Tempo- und Taktzuordnung 354
Timecode Mapping Options 361
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Import as Offline Satellite Media 351, 361
Import Audio (Dialogfeld) 332
Import Audio to Track (Befehl) 332
Import Clip Groups (Befehl) 382
Import Key Signature Map (Option) 354
Import Memory Locations 354
Import Rendered Audio Effects 363
Import REX Files as Clip Groups (Option) 126, 337
Import Session Data (Befehl) 347
Import Settings (Plug-In-Befehl) 1053
Import Settings (Schaltfläche im 

I/OSetup-Dialogfeld) 102
Import Video (Befehl) 1273
Import Volume Automation 363
importieren 325
Importieren von Audio aus QuickTime-Movies 1277
Importieren von Fensterkonfigurationen 354
Importieren von HEAT Master-Einstellungen 355
Importieren von Markern 354
Importieren von Videos 1273
Impulse pro Frame

Bi-Phase/Tach 137
Inaktiv 17

Ausgänge 239
Eingänge 239
Inserts 1041
Master-Fader und Zuweisungen 983
Pfade 93
Pfade, global 93
Sends 1005
Spuren 249
Spurpfadzuweisungen 239

Include Control Changes in Undo Queue 
(Option) 118

Include Sends in Trim Mode (Option) 118
Incoming Time (Anzeige) 1205
Input Devices (Befehl) 480
Input Filter (Befehl) 482

MIDI Event List View Filter (Dialogfeld) 781
MIDI Input Filter (Dialogfeld) 482

Input Only-Monitoring-Modus 449
Input Path-Selektor 210, 236
Input Quantize (Befehl) 935, 961
Insert Position-Selektor 1046
Insert Silence (Befehl) 869
Insert Time (Befehl) 824, 827
Insertion Follows Playback (Option) 108, 421

Inserts 989, 1037
beschriften 1067
deaktivieren und aktivieren 1041
duplizieren 1045
Einzelspur-Bearbeitung 1038
Hardware-I/O 1038
Hardware-Insert-Delays 75
in Submix gemeinsam verwenden 1019
mono 1038
mono-zu-stereo 1038
Plug-Ins 1037
Post-Fader-Inserts auf Master-Fadern 982, 1037
Send- und Return-Bearbeitung 1038
stereo 1038
verschieben 1045

Inserts-Bedienfeld 993
Inserts-Bedienfeld (Optionen) 990
Instrumenten-Plug-Ins 496
Instrumentenspuren 202

abhören und mischen 1015
aufnehmen 484
Clip-Darstellung 226
Kanalzüge 206
MIDI Input-Selektor 245
MIDI Output-Selektor 245
Notendarstellung 226
Signalfluss 984
Spur-Steuerelemente 209
Surround-Mischen 1175

Instruments-Bedienfeld 993
Interleaved-Audiodatei 158
Interleaved-Option (Sessions) 158, 1205
Interleaved-Stereodateien exportieren 341
Internal-Modus (Clock Source-Option) 1204
Interne Sidechain-Bearbeitung 1052

J
Jam Sync 1209
Join (Befehl) 1075

K
Kanäle 11
Kanalzüge 11

Audiospuren 203
Auxiliary-Eingänge 204
Instrumentenspuren 206
Master-Fader-Spuren 204
MIDI-Spuren 205
VCA Master-Spuren 205
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Kanalzuweisung
neu zuweisen 95

Kanalzuweisung im I/O Setup (Dialogfeld) 94
Kataloge (Workspace) 287
Kein Scrollen während der Wiedergabe 413
Key Input-Selektor 893, 1046
Key Signature Map 354
Key-Eingang 1046, 1052
Klick- und Knackgeräusche vermeiden 529
Knowledge Base 198
Kompatibilität 3, 1317
Komprimieren von Audiodateien 621
Konfigurieren

MMC 1219, 1220
SMPTE 1209

Konsolidieren von Medien 319
Kontinuierliches Zoomen 548, 549
Konvertieren von Sessions 164
Kopieren

Einstellungen für Spursteuerelemente in 
Sends 1007

MIDI-Noten mit dem Split-Befehl 959
Plug-In-Einstellungen 1055
Selektionen und Clips 539
Spurautomation auf Sends 1088

Koppeln
Multimono-Plug-Ins 1176
Plug-In-Steuerelemente 1067
Stereo-Panner 1011, 1190
umgekehrte Panoramasteuerung 1011

Koppeln mit Quellmedien 376

L
Last Used 102
Latch (Option) 248
Latch Record Enable Buttons (Option) 111
Latch Trim-Automationsmodus 1078
Latch-Automationsmodus 1075

AutoJoin 1075
Join 1075

Latching Behavior for Switch Controls in “Touch” 
(Option) 117

Latenz 54
Launch Setup App (Schaltfläche) 59
Lautstärkeanzeige 211
Lautstärkeautomation 1103
Lautstärke-Fader 211
Leisten

alle anzeigen 793
Anzeigereihenfolge ändern 793

Dirigentenleisten 793
Pull-Up und Pull-Down 1216
scrollen 590
vergrößern 552
Zeitbasis-Leisten 791

Leisten-Darstellungsoptionen 793
Bars|Beats-Zeitskala 791

Levels of Undo (Voreinstellung) 115, 537
LFE

Fader 1197
in Plug-Ins aktivieren 1197
Routing-Beispiele 1183

Librarian-Menü 1047
Limit Character Set (Option) 167
Linear (Befehl im Tempo Operations-Fenster) 814
Linear Sample Display 811
Linear Tick Display 812
Lineare Crossfades 631
Linearitäts-Anzeigemodus 811
Link Enable (Schaltflächen) 1049

in Multimono-Plug-Ins 1177
Link Mix and Edit Group Enables (Option) 116
Link Record and Play Faders (Option) 111, 450
Link Selection (Schaltfläche) 575, 577
Link Timeline and Edit Selection (Option) 575
Link to Source Media (Video) 351, 361
Link Track and Edit Selection (Option) 223, 577
Link-Steuerelemente 1321

anzeigen 1322
Link-Schaltfläche 1321
Mini-Link-Schaltflächen von einer 

Bedienoberfläche aus zugreifen 1322
Satellite Link-Schaltflächen 1322
Systeme mit einer Bedienoberfläche 

verknüpfen 1322
Local Control 481
Locators to Import 364
Lock Clip (Befehl) 864

AudioSuite-Rendering 897
Lock Settings File (Befehl) 1053
Locked (Anzeige) 1207
Locked (Spurbefehl) 235
Lokale Voreinstellungen (aktuelle Session) 133
Loop Playback (Option) 418

Touch-Modus 1086
Loop Record-Modus 437, 470
Loop-Aufnahme

Audiomaterial 470
mehrere Takes (MIDI) 492
MIDI 490, 491
Pre-/Post-Roll 470
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Loop-Clips 873
aufheben 875
Automationsdaten ausschneiden, kopieren 

und einfügen 877
editieren 875
erstellen 874
mit Loop-Trim-Tool trimmen 564
selektieren 875

Loop-Punkte 459
Timeline-Selektionsmarker 460

Loops
Clips 873
Loop-Trim-Tool 563
mit Hall oder Delay aufnehmen 1141
mit Loop Trim-Tool erstellen 563
Selektionen 419
Wiedergabe 418

Loop-Trim-Tool 563
Löschen

Automationsdaten 1098, 1106
Gruppen 263
in MIDI Event-Liste 786
Memory Locations 845
MIDI-Noten 710
nicht genutzte Clips 279
Pfade in I/O Setup 93
Playlists 647
Programmwechsel 720
Spuren 224
Sysex-Events 721

Low Latency Monitoring (Option) 452
Low Latency Monitoring path 80
LTC Output Level (Einstellung) 136

M
Machine Chases Memory Location 

(Option) 130, 1221
Machine Control (Peripherals, Dialogfeld) 138
Machine Cues Intelligently (Option) 131
Machine Follows Edit Insertion/Scrub 

(Option) 130, 1221
Machine Track Arming-Fenster 1223
MachineControl (Option) 50
Mac-Sessions

Kompatibilität mit Windows 391
Main Timebase-Leiste 794
Make Inactive (Spurbefehl) 235, 249
Manual Tempo-Modus 183, 434
Manually Find and Relink 387

Marker 364, 841
bearbeiten 844
erstellen 837, 839
exportieren 345
importieren 343, 354
löschen 845
Optionen anzeigen 846
Selektionen erweitern 582
sortieren 847
Tick- und samplebasierte Zeit 841
verschieben 844

Marker-Leiste 793, 841
Marketplace (Menü) 187
Master Link (Schaltfläche) 1049

in Multimono-Plug-Ins 1177
Master-Darstellung von Spuren 230, 1107
Master-Fader 982

Eingang eines Submixes trimmen 984
inaktiv 983
Inserts 1037
Kanalzüge 204
Master-Lautstärkeregelung im 

Stereoformat 984
mehrkanalig 1175
Post-Fader-Inserts 982
Pre-/Post-Fader-Pegelanzeigen 983
Signalfluss 982
Spur-Steuerelemente 207
zur Steuerung des Master-Send-Pegels 1023

Mastering 1156
Matches 659
Matching Criteria-Fenster 474, 657
Mausrad

im Edit-Fenster zoomen 558
in einem ProTools-Fenster scrollen 590
Notendarstellung für MIDI-Spur 532, 558

Mbox 41
Mbox-Produktfamilie 41
Media Composer

Edit Play Rate 1315
Fehlerbehebung bei 

Satellite-Verbindungen 1314
mit Pro Tools verknüpfen 1321
Project Type 1315
Starting TC Timecode (Einstellung) 1315
Timecode Format 1315
Video Satellite 143, 1311

Media Composer
verknüpfen und Verknüpfung aufheben 1322

Mediendaten 19
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Mehrere Spuren
Audioclips an Edit-Selektion anpassen 623
Beat Detective 681
Clips mit der Nudge-Funktion verschieben 608
Clips separieren 602
Clips verschieben 854
editieren 542
einfügen 542
selektieren 584
Selektionen erweitern 584, 585
Takes abhören 473, 660

Mehrkanal-Clips 525
Mehrkanal-Plug-Ins 1176
Mehrkanalspuren 455

Automation 1105
Clips ersetzen 861
Clips ziehen 611
Namen 440
splitten 610

Mehrsprachige Anwendungsunterstützung 402
Memory Location

Edit-Selektionen aufrufen 463
Memory Location-Liste 837, 841
Memory Locations

aufrufen 843
bearbeiten 844
Edit-Selektionen speichern 462
erstellen 837, 839
importieren 354
löschen 845
Marker 841
Selection Memory Locations 841
Selektionen erweitern 582
umbenennen 843

Memory Locations (Fenster)
Ansichtsfilter 848
Marker-Optionen anzeigen 846

Memory Locations-Fenster 840, 843
Merge-Modus (siehe MIDI Merge-Modus)
Metadaten 19, 1233
Meter Path-Selektor 77
Meter-Events 822
Metering, erweitert 216

Advanced Meter Type (Einstellungen) 122
Anzeige der Gain-Reduktion 217
Digital VU (Option) 121
Fader- und Pegelanzeige 216
K (Optionen) 121
Linear (Extended, Option) 120
Linear (Option) 120
Meter Type (Einstellung) 217

PPM (Optionen) 121
Pro Tools Classic (Option) 120
RMS (Option) 121
Sample Peak (Option) 120
VENUE (Optionen) 122
VU (Option) 121

Metering-Voreinstellungen 120
Meter-Leiste

anzeigen 822
Edit-Selektion erweitern 823

Metronom (Klick) 431, 432
Metronom (Schaltfläche) 432
Metronome Click (Schaltfläche) 183
Metronomspur 431
Mic Preamps

konfigurieren 142
Mic Preamps-Bedienfeld 992
MIDI 6

Controller-Events 712
Default Thru Instrument 481
importieren 343
in einem MIDI Editor-Fenster editieren 748
Kanäle zuweisen 244
Loop-Aufnahme 491
MIDI-Einstellungen konfigurieren 57
Noten konsolidieren 707
Noten selektieren und teilen 959
Noten separieren 705
Noten stummschalten 707
Offsets 723
Patch-Namen 717
Patch-Namen-Datei (.midnam) 717
per Drag & Drop importieren 344
Rasterwert zum Editieren festlegen 695
Studio-Setup (Mac) 145
Studio-Setup (Windows) 148
wiedergeben 406

MIDI (Anzeige) 212
MIDI Beat Clock

Offsets 425
über IAC übermitteln 424
übermitteln 424

MIDI Controllers 140
MIDI Editor

Automation-Lanes 753
Controller-Lanes 753
Darstellung überkopierter Noten 746
MIDI-Noten editieren 748
Notationsdarstellung 751
Velocity-Lane 753
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MIDI Editor (Fenster) 735
MIDI Editor-Bedienfeld (im Edit-Fenster) 184
MIDI Event List 779

Events auswählen 785
Events bearbeiten 782
Events editieren 785
Events löschen 786
navigieren 781
Options (Menü) 787
View Filter 780

MIDI File Format (Popup-Menü) 344
MIDI importieren 343
MIDI Input-Selektor 210, 243

Instrumentenspur 245
MIDI Machine Control (MMC)

Master (Einstellungen) 138
Slave (Einstellungen) 138

MIDI Merge-Modus 183, 439, 483
MIDI Note Color Shows Velocity (Option) 107
MIDI Note Display (Optionen) 130
MIDI Operations (Fenster) 935
MIDI Output-Selektor 210, 244

Instrumentenspur 245
MIDI Replace-Modus 183, 439, 483
MIDI Setup (Befehle)

Input Devices (Befehl) 480
Input Filter (Befehl) 482

MIDI Studio Setup (MSS) (Windows) 57, 148, 717
MIDI Thru (Befehl) 481
MIDI Track Offsets (Befehl) 724
MIDI Zoom In (Schaltfläche) 549
MIDI Zoom Out (Schaltfläche) 549
MIDI-Aufnahme 479

bei Eingabe quantisieren 482, 961
Eingabegeräte aktivieren 480
Eingangsfilter 482
Merge/Replace Modus 483
MIDI Thru abhören 481
System Exklusive-Daten 494
Take rückgängig machen 488
Takes abbrechen 488
Wait for Note 482

MIDI-Beat-Clock 423
MIDI-Clips 530

auf Taktstrichen 487
Clipliste 269
Controller-Events 531
Punch-Aufnahmen 490
Richtlinien zum Editieren 530

MIDI-Controller 479
lokale Steuerung 481

MIDI-Controller-Events
Chasing 722

MIDI-Dateien (siehe Standard-MIDI-Dateien)
MIDI-Echtzeit-Eigenschaften

auf Spuren und Clips 731
MIDI-Echtzeiteigenschaften 726

Einstellungen 728
MIDI-Lautstärke-Fader 212
MIDI-Maschinensteuerung (MMC) 1218

externe Geräte steuern 1218
in Pro Tools konfigurieren 1219, 1220

MIDI-Noten 701
Anfangs- und Endpunkte trimmen 704
Attribute 709
ausgewählte duplizieren 871
Chasing 722
editieren 700

Dauer 954
Tonhöhe 703
Velocity-Werte 707, 952

einfügen 698
Länge in Ticks 796
löschen 710
Mini-Keyboard 701
quantisieren 943
scrollen 532
selektieren 700
teilen 959
transponieren 703, 956
verschieben 704

MIDI-Programmwechsel
Chasing 722

MIDI-Setup (Befehle)
MIDI Beat Clock (Befehl) 423

MIDI-Spuren
aufnehmen 479, 484
Ausgang 244
Clip-Darstellung 225, 227, 530
Eingang 243
Kanalzüge 205
Loop-Aufnahme 490
mehreren Kanälen zuweisen 484
MIDI-Offsets 723
Note-Chasing 722
Noten eines bestimmten Tonhöhenbereichs 

selektieren 960
Notendarstellung 226, 227, 532
Punch-Aufnahme 488, 489
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Spur-Steuerelemente 208
Standard-Program Change 716
Sysex-Darstellung 721
Velocity-Darstellung 707

MIDI-Timecode (MTC)
MTC-Ausgabe während inaktiver Phasen 136

MIDI-Voreinstellungen 128
Global MIDI Playback Offset 

(Voreinstellung) 723
Pencil Tool Resolution When Drawing 

Controller Data 129, 1101
Pencil Tool Resolution When Drawing 

Controller Data (Option) 714
MIDI-Voreinstellungen (Registerkarte) 128
Mikrofonvorverstärker

I/O-Setup 74
Mini-Keyboard 532, 701
Minimize Additional I/O Latency (Option) 55
Minimum Sync Delay (Option) 131, 1222
Minutes:Seconds-Zeitskala 792
Mirror MIDI Editing 695
Mix (Fenster)

All (Ansichtsoption) 172, 992
None (Ansichtsoption) 992
Spurbreite 219
Spur-Steuerelemente 172

Mix Window Follows Bank Selection (Option) 117
Mix-Busse 393, 1002
Mixdown auf Stereo 1156
Mix-Fenster 172, 173
Mix-Fenster (Ansichtsoptionen) 992
Mix-Gruppen 261
Mixing-Voreinstellungen 116
MMC (siehe MIDI-Maschinensteuerung)
Modify (Gruppenbefehl) 259
Modify Groups (Befehl) 258
MojoDX 1259, 1311
Momentary (Solo Latch-Option) 248
Monitoring

während Punch-Aufnahmen 467
Monitoring

MIDI-Aufnahme mit MIDI Thru 481
Monitoring-Modi 448

Auto Input 448
Input Only 449

Move Song Start (Befehl) 824, 829
MP3-Dateiformat 1145

importieren 327
MTC (MIDI-Timecode) 1209
MTC Generator Port (Einstellung) 136

MTC Reader Port (Einstellung) 136
Multicam-Auflösungsdateien 357
Multimono

Plug-In-Channel-Selektor 1176
Plug-Ins 1176

Multimono-Audiodateien 158
Mute Audio Inputs in Auto Input (Option) 520
Mute Overwrite/Extend (Befehl) 1120
Mute Record-Armed Tracks While Stopped 

(Option) 112, 520
Mute/Unmute Clip (Befehl) 866
Mute-Schaltfläche 249
MXF-Format 327, 1146

N
Narrow Mix (Option) 219
Native-Plug-Ins

Latenz 1039
Voice-Nutzung 1039

Navigieren
mit Fast Forward/Rewind 410

Navigieren in Workspace-Browsern 285
Nebenpfade 70, 90

Beispiele für Anschlüsse bei 
Surround-Monitoring 1178

Nebenzähler-Selektoren (Sub) 795
Neufestlegen

Feet+Frames-Position 1211
Timecode-Position 1211

Neukopplung
Find Links (Befehl) 316
Kopplungsoptionen 316

New Group (Befehl im Groups-Listen- 
Popup-Menü) 258

New Memory Location-Dialogfeld 462
New Paths-Dialogfeld 88
New Session (Befehl) 102, 156
New Track (Befehl) 219, 235
New Track Default Output-Selektor 78
New Tracks Default To Tick Timebase 

(Option) 114, 339
Next Setting (Schaltfläche, Plug-Ins) 1047
Nicht verfügbare Ein- und Ausgänge 104
Nicht verfügbare Session-Elemente 161
Nicht zusammenhängende Selektionen 580
Nichtdestruktive Aufnahme

in neuer Playlist 469
mit QuickPunch 502

nichtdestruktive Aufnahme 467
Nichtdestruktives Editieren (Audio) 529
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Nichtdestruktives Editieren (MIDI) 533
Nicht-Echtzeit-Plug-Ins 889
Niedriglatenz-Monitoring

BounceToDisk 453
NitrisDX 1259, 1311
No Output (Option) 997
Nondestructive Record-Modus 436
Non-Linear Transport Error Suppression 

(Option) 131
Normal Zoom-Modus 551, 756
Notationsdarstellung 751
Note Chasing (Option) 722
Note Selector-Tool 702
Noten (siehe MIDI-Noten)
Notendarstellung 226, 227, 532
Notenhänger 725
Nudge-Funktion

Clips mit Fades 639
Fades 638
Inhalte von Clips 609
mehrere Clips 608
Nudge-Wert einstellen 607
Selektionen und Clips 608
Selektionsbereich 581
Start-/Endpunkt einer Selektion 

verschieben 582
um nächsthöheren Nudge-Wert 

verschieben 608
Nudge-Funktion, verschieben mit 607
Nudge-Wert 607

Clips trimmen 606
MIDI-Noten trimmen 705

Number of Voices (Einstellung) 56

O
Object Grabber-Tool 566, 580
Object Select in Edit Window (Befehl) 280
Objektselektionen 580
Offline

Clips 525
Dateien, in Workspace auswählen 290

Offline-Bounce (schneller als in Echtzeit) 1153
Öffnen von AAF-Sequenzen in Pro Tools 356
Öffnen von OMF-Sequenzen in Pro Tools 356
Offset

für Startzeiten in Video Satellite-Systemen 
einstellen 1309

OMF 367
eingebettete Medien 22
exportieren 373

importieren 355
in Pro Tools öffnen 356
Mediendaten 19
Metadaten 19, 1233
Publishing Options 377
Umwandlungseinstellungen importieren 363
verknüpfte Medien 23

On the Fly-Punch-Aufnahme
QuickPunch 438, 505

Online (Schaltfläche) 180
Online-Aufnahme 1217
Online-Hilfe 1313
Online-Optionen 112
Open Session (Befehl) 160
Open Unresourced DSP Plug-Ins as Native 

(Voreinstellung) 128
Operation Preferences

Audio During Fast Forward/Rewind 
(Option) 410

Edit Insertion Follows Scrub/Shuttle 
(Option) 569

F11 für „Wait for Note“ 483
Machine Chases Memory Location 

(Option) 1221
Machine Follows Edit Insertion/Scrub 

(Option) 1221
Operation Preferences (Betriebs-Voreinstellungen)

Record Online (Option) 1217
Operation/Destination Track (Popup-Menüs) 352
Operations (Menü)

Calibration Mode (Befehl) 430
Link Timeline and Edit Selection (Option) 575
Link Track and Edit Selection 223, 577
Low Latency Monitoring (Option) 452

Operations Preferences
Clip Auto Fade In/Out Length 

(Voreinstellung) 637
Operation-Voreinstellungen

Link Record and Play Faders (Option) 450
Option (Menü)

Auto-Spot Clips (Befehl) 1226
Options (Menü) 198

Delay Compensation (Option) 1024
Destructive Record (Modus) 468
Link Track and Edit Selection (Option) 223, 577
Loop Playback (Option) 418
Loop Record-Modus 470
MIDI Thru (Befehl) 481
Mirror MIDI Editing (Befehl) 695
Pre/Post Roll (Option) 465
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Pre-Fader Metering (Option) 213
Scrolling (Optionen) 413
Solo Latch (Optionen) 248
Transport Online (Befehl) 1216

Organize Plug-In Menus By (Option) 106, 1043
Originalzeitstempel 858, 1227
Other Playlists (Menü) 646
Output (Fenster) 996
Output Meter Path-Selektor 77
Output Options

Conversion Quality (Option) 1149
Sample Rate 1148

Output Path-Selektor 210, 237
Output Window-Schaltfläche 1187

P
P (Playback – nur Wiedergabe) 286
Page (Scrolling-Option) 413, 741, 762
Pan Odd Tracks Left/Even Tracks Right 364
Pannen

3-Knopf 1192
Feinabstimmungsmodus 1191
gekoppeltes Stereo 1011, 1190
im Raster übernehmen 1191
Mehrkanal-Automations-Playlists 1197
Richtlinien 1180, 1182
Use Absolute Pan Linking (Option) 116
Verlauf 1193
X/Y-Modus 1191

Panning
Automation und Gruppen 1106
Raster 1186

Panorama-Anzeige 211
Panoramaautomation 1103
Panorama-Schieberegler 211
Pan-Tiefe 990
Parabolic (Befehl im Tempo Operations- 

Fenster) 815
Partitur drucken 777
Paste (Befehl) 540
Paste Settings (Befehl) 1053
Paste Special (Automationsbefehle) 1109
Patch Select (Schaltfläche) 716
Pausen (Score Editor) 772
Peak Hold (Optionen) 123, 213
Peak-Darstellung 526
PEC/Direct Style Input Monitoring (Option) 112

Pegelanzeige
Audiospuren 212
Auxiliary-Eingangs-, Instrumenten- und 

Master-Fader-Spuren 212
Pegelanzeige für Spuren 212
Pegelanzeigen

Bedienoberflächen 77
MIDI-Spuren 212
Pre-/Post-Fader-Pegel 213
Send-Ansicht 1004

Pegelanzeigen- und Faders-Bedienfeld 993
Pencil-Tool

Random 698
Pencil Tool Resolution When Drawing Controller 

Data (Option) 129, 714, 1101
Pencil-Tool

als Eraser-Tool 710
Auflösung von eingefügten Controller- 

Events 714
Automationsdaten zeichnen 1100
Breakpoints editieren 1102
Clip-Gain bearbeiten 615
Form auswählen 696
Formen 696, 1100
Free Hand 697
Line 697, 806
MIDI-Noten einfügen 698
Square 697
Tempo bearbeiten 806
Triangle 697
Wellenformen reparieren 572

Performance-Volume 283
Peripherals (Dialogfeld) 135, 479
Peripherals-Liste 61, 62
Peripheriegeräte

Ethernet-Controller 141
Maschinensteuerung 138
MIDI-Controller 140
PRE 142
Satellites 142
Synchronisation 135
VENUE 144

Personality-Dateien 1034
Pfade 70

Abhören 78
aktiv und inaktiv 93
anpassen 90
auswählen 92
bearbeiten 90
Beispiele für Mehrkanalpfade 94
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Beispiele für Nebenpfade im Surround- 
Format 1181

erstellen 87
für Surround 1177
Hauptpfade 70
löschen 93
Mehrkanal, erstellen 1166
Nebenpfade 70
Standard, Mono und Stereo 91
Standardanordnung 80
Standardausgang 78
Überschneidung 95
verschieben 93
zuletzt verwendet 102
zuweisen 94

PFL (Pre Fader Listen) 247
Pitch Memory Enabled (Option) 136
Pitchshifting 930
Play (Schaltfläche) 180
Play Edit Selection (Befehl) 415, 417
Play MIDI Notes When Editing (Option) 693
Play Start Follows Timeline Selection (Option) 108
Play Start Latency (Einstellung) 110
Play Start Marker Follows Timeline Selection 

(Option) 421
Play Timeline Selection (Befehl) 415, 417
Playback Engine 52

Cache-Größe 57
Hardware-Puffergröße 54
Host Engine 54
Sample Rate 57
Voice-Anzahl 56

Playback Engine-Einstellung 53
Playback-Cursor 408
Playback-Cursor-Locator 408
Playhead 414, 741

an Clip-Grenzen verschieben 417
Edit-Selektionen 417
Timeline-Selektionen 417

Playlist-Lanes 651
Playlists 11, 645

auf neuer Playlist aufnehmen 469
aufrufen 646
Automation 1072, 1081
Automation-Playlists 645
automatisch benennen 645
duplizieren 646
Edit-Playlists 645
Gruppen 647
hinzufügen 646

löschen 647
Mehrkanalspuren 1105
nichtdestruktives Editieren von MIDI 533
Playlist-Selektor 645
Pre-/Post-Roll einstellen 464
umbenennen 647
Zeitbasis ändern 797
zuweisen 646

Playlists-Darstellung 651
Playlist-Selektor 11, 645
Plug-Ins

automatisieren 1089
Plug-In Controls Default to Auto-Enabled 

(Option) 117
Plug-In Settings Select (Schaltfläche) 1047
Plug-In Settings-Menü 1047, 1053
Plug-In-Einstellungen 1055

anpassen 1050
Plug-In-Fenster

öffnen und schließen 1049
Plug-In-Inserts 1037
Plug-In-Maps 1059
Plug-Ins

auf Spuren einschleifen 1042
aus Spuren entfernen 1042
Automation aktivieren 1051
Bypass-Schaltung von Fenster 1065
Category 1043
Category and Manufacturer 1044
Channel-Selektor für Multimono 1176
Favoriten 1045
Flat List 1043
für die Automation aktivieren 1090
für Surround 1176
Koppeln und Aufheben der Kopplung 1067
Koppeln und Kopplung aufheben 1176
Librarian (Menü) 1047
Manufacturer 1044
mehrkanalig 1038
mono zu stereo 1038
multimono 1038, 1176
Next Setting (Schaltfläche) 1047
Organize Plug-In Menus By (Befehl) 1043
Plug-In Settings (Menü) 1047
Plug-In Settings Select (Schaltfläche) 1047
Previous Setting (Schaltfläche) 1047
Pull-Werte 1216
Standardeinstellung erstellen 1055
Surround-Mischen 1176
Voreinstellungen 1053
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Plug-In-Selektor
AudioSuite Plug-Ins 890
Echtzeit-Plug-Ins 1046

Plug-In-Steuerelemente
anpassen 1050
koppeln 1067

Plug-In-Zuweisungen
erstellen 1061
importieren und exportieren 1064
Learn-Modus 1059
löschen 1063
Standard festlegen 1063
verwalten 1062

Positionen
MIDI-Noten quantisieren 941
MIDI-Noten ziehen 704
Zufallswert bei MIDI-Noten 939, 942

Positionieren
mit Positionsanzeigen 590

Positionieren im Spot-Modus
Clips 857, 1223, 1225

Positionsanzeigen 589, 590
Post-Crossfades 626, 636
Post-Roll (Schaltfläche) 182
Power-Darstellung 527
PRE 49

I/O-Setup 74
konfigurieren 142

Pre Fader Listen(PFL)-Modus 247
Pre- und Post-Roll-Flags 465, 576
Pre/Post Roll (Option) 465
Pre-/Post-Fader (Schaltfläche) 1012
Pre-/Post-Fader-Inserts 1037
Pre-/Post-Roll

abhören 415
einstellen 463
Loop-Aufnahme 470
Punch-Aufnahme 466

Pre-Crossfades 626, 636
PRE-Einstellungen 354
Pre-Fader Metering (Option) 213
Preferences

Automatically Copy Files on Import 
(Option) 349

TrackInput 450
Prepare DPE Tracks (Befehl) 514
Pre-Process using Standard Conform (Option) 684
Pre-Roll (Schaltfläche) 181

Preserve Fades when Editing (Option) 115
Preserve Folder Hierarchy (Befehl) 168
Prevent Tearing (Option) 110
Preview

AudioSuite-Bearbeitung 894
Preview Volume

AudioSuite 895
Previous Setting (Schaltfläche, Plug-Ins) 1047
Prime for Playback-Modus (Play Pause) 418
Prime for Record-Modus (Record Pause) 459
Pro Tools

Audio-Pull-Up und -Pull-Down 1315
Clock Reference (Einstellung) 1315
Drop-Frame (Einstellung) 1315
Non-Drop-Frame (Einstellung) 1315
Session Start (Einstellung) 1315
Sessiondatei 159
Session-Datei-Symbol 8
Systeme 39
Timecode Rate (Einstellung) 1315
Video Format (Einstellung) 1315
Video Satellite 1314
Video Satellite-Einstellungen 1315
Videospur 1264

Pro Tools Help (Befehl) 188
Pro Tools Knowledge Base (Befehl) 188
Pro Tools- und Avid-Begriffe 21
Pro Tools-Systeme

QuickPunch 500
Pro Tools-Webbrowser 188
Process Mode-Selektor 892
Processing-Voreinstellungen 125
Program Change (Dialogfeld) 716, 718
Program Changes 715

Bank Select 715
Standard, bei MIDI-Spuren 716

Programmwechsel
abhören 720
editieren 719
einfügen 719
löschen 720
verschieben 719

Project Type (Media Composer) 1315
ProTools

Check For Updates 198
Dateiverwaltung 385
Hauptmenüs 197
Hilfe 198
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Knowledge Base 198
Link-Steuerelemente 1321

anzeigen 1322
Systeme verknüpfen und Verknüpfung

aufheben 1322
Webbrowser 186

ProTools (Menü)
Quit (Mac-Befehl) 170

Pro Tools HD
Funktionen mit HD Native-Hardware 43
Funktionen mit HDX-Hardware 42

ProTools-Softwareoptionen 40
Puffergröße (Hardware) 451
Pull-Up und Pull-Down 1213, 1216
Punch Capture (Schaltfläche) 1130
Punch In Frame Offset (Voreinstellung) 132
Punch Out Frame Offset (Voreinstellung) 132
Punch Preview (Schaltfläche) 1128
Punch-Aufnahme

Audio 465
MIDI 488
MIDI-Spuren 489
Monitoring 467
Pre-/Post-Roll 466

Punch-Punkte 459
Timeline-Selektionsmarker 460

Q
Quantisieren

Audioclips 939, 949
bei der Eingabe von MIDI 482, 961
Clips am Raster 609
Elastic Audio-Events 939, 948
MIDI-Noten 938, 943

Quantisieren von Clips am Raster (Befehl) 859
Quantize

Real-Time Properties 728
Quantize (Befehl) 935, 937
Quantize (Fenster) 940
Quantize Edits to Frame Boundaries (Option) 374
Quantize to Grid (Befehl) 609
Quellmedien 360, 376
Quellpfad 1143
Quick Start (Dialogfeld) 153
QuickInfos 106, 199
QuickPunch

Crossfades 503
Nummerierung von Clips und Takes 502
Pro Tools HD-Systeme 500

QuickPunch Crossfade Length 
(Voreinstellung) 115, 503

QuickTime-Dateiformate 1146
QuickTime-Movies

Audio importieren 1277
Sync 1288
Wiedergabe optimieren 1287

Quit (Mac-Befehl) 170
QuickPunch 438, 500, 505

R
R (Record – Aufnahme und Wiedergabe) 286
Rasterwert 695, 859

für MIDI-Editing festlegen 695
Read Trim-Automationsmodus 1078
Read-Automationsmodus 1074
Real-Time Properties

auf Spuren schreiben 732
auf Spuren und Clips 731
Bedienfeld 726
clipbasiert 731
Delay 730
Duration 729
Einstellungen 728
im Edit-Fenster 733
in Clips schreiben 732
Quantize 728
spurbasiert 732
Transpose 731
Velocity 730

Real-Time Properties (Fenster) 727
Real-Time Properties-Bedienfeld 726, 994
Rear Divergence 1194
Recalculate Waveform Overviews (Befehl) 280
Recall Memory Location Selection at Original Track 

(Option) 114
Record (Transport-Schaltfläche) 181
Record Enable-Anzeige einer Spur 181
Record Enable-Schaltfläche 442, 507
Record Online (Option) 1217
Record Online at Insertion/Selection (Option) 112
Record Online at Timecode (or ADAT) Lock 

(Option) 112
Record Safe-Modus 444
ReCycle 327
Redo (Befehl) 535
Ref Present (Anzeige) 1207
Refer to Source Audio Media (Where Possible) 

(Option) 360
Regenerate Missing Rendered Files (Befehl) 387
Regroup Clip (Befehl) 879
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Relative Grid-Modus 545, 859
Remote Mode (Optionen) 132
Remove Duplicate Notes (Befehl) 725
Remove Sync Point (Befehl) 863
Rename (Befehl im Clipliste-Menü) 278, 280
Rename (Spurbefehl) 235
Renamed Audio Files

Save Copy in 388
Render Clip Gain (Befehl) 620
Rendered Files (Ordner) 159, 912
Renumber Bars (Befehl) 830
Repeat (Befehl) 871
Repeat to Fill Selection (Befehl) 541
Replace Clip (Befehl)

Mehrkanalspuren 861
Replace Clip (Dialogfeld) 861

Replace-Modus (siehe MIDI Replace-Modus)
Reserve Voices For Preview In Context 

(Option) 108, 310
Reset Bi-Phase (Schaltfläche) 137
Restore Performance (Befehl) 935, 950
Return to Zero (Schaltfläche) 180
Reveal in Explorer (Windows-Befehl) 280
Reveal in Finder (Mac-Befehl) 280
Revert to Saved (Befehl) 163
Rewind 410
Rewind (Schaltfläche) 180
REX-Dateien 327

importieren 335
Root Settings (Ordner) 1053, 1054
Round Robin-Zuweisung 446
Ruler View (Optionen)

Feet+Frames-Zeitskala 792
Minutes:Seconds-Zeitskala 792
Samples-Zeitskala 792
Timecode-Zeitskala 792

Ruler View-Selektor 793

S
Sample Rate (Einstellung) 1148

Hardware Setup (Dialogfeld) 60
Playback Engine (Dialogfeld) 57

Sample Rate Conversion (Optionen) 352
Sample Rate Conversion Options 362, 375
Sample Rate Conversion Quality 127, 327, 338, 

375, 1148
Sample Rate Convert Audio 362
Samplebasiertes Timing 795, 841
Sample-Offset (Sync-Offset) 1208

Samplerate des Audio-Quellmaterials 362
Samplerate des Audio-Zielmaterials 363
Samplerate-Konvertierungs-Qualität 363, 1277
Samples-Zeitskala 792
Satellite Link

Option 142
Voreinstellungen 132

Satellites 142
Save (Befehl) 163
Save As (Befehl) 164
Save Copy In (Befehl) 164, 392
Scale (Befehl im Tempo Operations-Fenster) 817
Schließen von Plug-In-Fenstern 1049
Schnellvorlauf (Fast Forward) 410
Schreiben

Automation 1085
Automation (On Stop-Modus) 1116
Automation auf ganze Selektion, zum Anfang 

oder Ende einer Selektion 1114
Schützen der Automation 1081
Score Editor

Akkordsymbole und -diagramme 775
drucken 777
editieren 769
öffnen 756
Page-Steuerelemente 764
Partitur exportieren 776
Pausen 772
Zoom-Steuerelemente 765

Score Setup (Fenster) 768
Scroll into View (Spurbefehl) 224, 235
Scroll To Track (Befehl) 222, 591
Scroll to Track Banks Controllers (Option) 117
Scrollen

einer Spur in die Ansicht 224
in der Leiste 590
in Leiste 552
MIDI-Noten-Darstellung 532
Notendarstellung nach oben bzw. unten 558
vertikal oder horizontal im Pro Tools-Fenster 590
zu Spuren im Mix- und Edit-Fenster 591

Scrolling (Optionen) 413
After Playback 413
Center Playhead 414
Continuous Scrolling During Playback 414
None 413
Page 413, 741, 762

Scrolling-Option „Center Playhead“ 414
Scrub Trim-Tool 562
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Scrubben 569
Auflösung 570
Edit-Cursor 569
einzelne Audiospur 569
Scrub Trim-Tool 562
Selector-Tool 570
Videospuren 1283
Wiedergabegeschwindigkeit und Richtung 570
zwei Audiospuren 570

Scrubber-Tool 547, 569
selektieren 585
Shuttle-Modus 570

S-Curve (Befehl im Tempo Operations-Fenster) 816
SDDS-Surround-Formate 1162
Sekundäre Timecode-Leiste 792
Select All (Befehl) 578
Select Clip List (Optionen) 275
Select Parent in Workspace (Befehl) 280
Select Tracks in Group (Befehl) 259
Select Unused Clips (Befehl) 279
Select/Split Notes (Befehl) 935, 959, 960

Split Notes (Befehl) 959
Selection (Befehle)

Play Edit Selection 415
Play Timeline 415

Selection Changes Alternate Playlists (Option) 797
Selection Memory Location 841

gespeicherte Selektion verschieben 844
Selector-Tool 409, 547, 565

Edit-Cursor platzieren 565
Edit-Selektion vornehmen 565
gesamte Spur selektieren 565
gesamten Clip selektieren 565
MIDI-Noten selektieren 701
scrubben 570
Timeline-Selektion vornehmen 565

Selektieren
Clips 578
MIDI-Noten 700, 701
mit Edit-Selektions-Anzeigen 583
mit Scrubber 585
nicht zusammenhängende Clips 580
Noten eines Akkords 961
Noten eines bestimmten 

Tonhöhenbereichs 960
Spurmaterial 577
über alle Spuren hinweg 584
über mehrere Spuren hinweg 584
während der Wiedergabe 579

Selektieren von Spuren für die 
AudioSuite-Bearbeitung 898

Selektionen
auf angrenzende Spuren verschieben 584
auf Meter-Leiste erweitern 823
auf nächsten/vorangehenden Clip 

verschieben 586
auf Tempoleiste erweitern 801, 845
ausgeblendete Spuren 578
ausschneiden 539
Bounce to Disk 1142
Dirigentenleisten einschließen 584
duplizieren 870
Edit-Gruppen 577
einfügen 540
erweitern 582, 809
konsolidieren 621
kopieren 539
Länge ändern 581
loopen 419
löschen 540
mit Memory Locations speichern 841
nicht zusammenhängend 580
Nudge-Funktion 581, 608
Objekt 580
Spur entfernen 585
Start- und Endpunkte abhören 415
Start-/Endpunkt mit der Nudge-Funktion 

verschieben 582
Timeline-Selektionsmarker 577
über mehrere Spuren hinweg 578, 584
verschieben 864
während der Wiedergabe 579
wiedergeben 415
wiederholen 871

Selektionen erweitern
zum nächsten Tempo-Event 809

Selektrieren
in MIDI Event-Liste 785

Send Level 998
Send Mute 998
Send Pan 998
Send Pans Default to Follow Main Pan (Option) 116
Send to Back (Befehl im Clip-Menü) 603
Send To Gobbler (Befehl) 384
Send To Sibelius-Befehl 776
Sends

Ansichtsoptionen 1002
Assignments-Ansicht 1002
automatisieren 1087
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beschriften 1067
entfernen 999
für Hardware-I/O 1002
hinzufügen 998
Mehrkanalformate mischen 1175
mehrkanalig 1175
Mix-Busse 1002
Mono oder Stereo 1002
Spurautomation kopieren auf 1088
Standardeinstellung ändern 999
Standardwert 999
Steuerelemente anzeigen 1004

Sends 998
Sends Default to -INF (Option) 116
Sends-Bedienfeld 993
Separate Clip (Befehle) 600

At Selection 600
At Transients 600
mehrere Spuren 602
On Grid 600
verwandte Takes 601

Separate Clip Operates On All Related Takes 
(Option) 114, 601

Separate Signalsteuerung 1172
Separation Grabber (Tool) 566, 602
Separieren von MIDI-Noten 705
Session

Parameter 166
Session Data Online Status (Anzeige) 176
Session Data to Import (Menü) 352
Session File Backups (Ordner) 160
Session Start (Einstellung) 1315
Session-Datei 159
Session-Daten

importieren 346
Sessions 8

Audioformat 1205
Backups 110, 160
Bitrate 157, 1204
Dateien 8
erstellen 156
Frame Rate 1205
für Surround-Mischungen erstellen 1163
gemischte Audioformate 158, 166
gemischte Bitrates 166
Interleaved 158, 1205
Mehrkanal-Interleaved-Audiodateien 158
Multimono-Audiodateien 158
öffnen 160
Samplerate 157, 1204

schließen 170
speichern 163
Start-Frame 1205
von Transfer-Volume öffnen 161
Vorlagen 169

Sessions Overwrite Current I/O Setup When 
Opened (Option) 81

Session-Setup-Fenster 1203
Set As User Default (Befehl) 1053
Set Plug-In Default To (Befehl) 1054
Set Record Tracks to Auto Input (Befehl) 450
Set Record Tracks to Input Only (Befehl) 450
Set Servo Lock Bit at Play (Option) 132
Setup (Menü) 198

Click/Countoff Options (Dialogfeld) 432
Disk Allocation 446
I/O-Setup 70
MIDI Studio 717
Preferences (Befehl) 105
Session Setup 1203

Setup (Menü)
Video Sync Offset (Befehl) 1288

Setzen
Punch-/Loop-Punkte 459

Share With SoundCloud (Option) 1150
Shift (Befehl) 864
Show All Tracks (Gruppenbefehl) 259
Show Auto-Created (Option) 279
Show Only Tracks in Group (Befehl) 259
Shuffle Lock-Modus 544
Shuffle-Modus 543

Clips verschieben 853
gesperrte Clips 865

Shuttle
Fixed Mode (Option) 571

Shuttle-Ziffernblockmodus 30, 109, 572
Sibelius-Datei (.sib) 776
Side% (Percentage) 1194
Sidechain 1052

bearbeiten 1046
Filter 1052

Signalfluss
Audiospuren 981
Auxiliary-Eingänge 982
Instrumentenspuren 984
Master-Fader 982

Signalpfade 70
Signal-Routing

Beispiel 13
Beispiele für Surround 1182
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Grundlagen 1174
Standardpfadanordnung 80

Signalspitzen 526
mit Beat Detective erkennen 670
springen 412, 587

Single Zoom-Modus 552, 757
SIP (Solo In Place) 246
Skalieren der Velocity-Werte von Noten 708, 952
Skip All 387
Slices 666
Slip-Modus 544

Clips verschieben 856
Smart-Tool 547, 566

Automationsdaten editieren 568
Controller-Events editieren 568
Crossfades erstellen 567
Elastic Audio-Spuren 567
Fades erstellen 567
Mehrkanalspuren 569
MIDI-Spuren 568

Smooth and Thin Data After Pass (Option) 117, 
1099

Smoothing von Automation 1080
SMPTE

Konfiguration 1209
Start-Frame (Sessions) 1205

Snap Pan to Speaker-Symbole 1190
Snap To (Befehle) 855
Snap To Bar (Option) 822
Snap to Grid 546
Snapshot-Automation 1123

leeren Automations-Playlists hinzufügen 1124
Trim-Werte 1126
vorhandene Automationsdaten 

überschreiben 1125
Software-Updates 50
Solo In Place(SIP)-Modus 246
Solo Latch (Optionen) 248
Solo Safe-Modus 248
Solo-Modi 246, 247
Soloschalten

Spuren 246
Spuren in einem Submix 1023

Solo-Schaltfläche 246
Songstart-Marker 798

Tempo bearbeiten 799
verschieben 798

Sony Dynamic Digital Sound (SDDS) 1162
Sort by (Optionen) 271

Sortieren
Clips 271
Daten in Browsern 293
Marker 847

SoundCloud 1150
Source Audio Sample Rate 375
Special Paste-Modus 1109
Speed Cal (Anzeige) 1207
Speichern einer Kopie der Session 164
Speichern einer Session 163
Speichern einer Session unter einem neuen 

Namen 163
Speichern von Elastic Audio 908
Speichern von Plug-In-Einstellungen 1055

Save Plug-In Settings To (Befehl) 1054
Save Settings (Befehl) 1053
Save Settings As (Befehl) 1053

Spitzenwertanzeige (Peak) 211
Split (MIDI) 959
Split Into Mono (Befehl im Track-Menü) 235, 610, 

1172
Split Notes (Befehl) 959
Split-Mono-Audiodateien 158
Splitten von Stereo- und Mehrkanalspuren 610
Spot (Dialogfeld)

Use Subframes (Option) 1224
User Time Stamp (Schaltfläche) 1226

Spot-Modus
Clips trimmen 1226

Spot-Dialogfeld 857, 1224
Spot-Modus 544, 1223

Clips verschieben 857
Spotting

im Spot-Modus automatisch 
positionieren 1226

Sprachoptionen 106
Spurbreite 219
Spur-Compositing 648
Spurdarstellung

ändern 229
Blocks 226
Clips 225, 227, 530
Inhalt editieren 538
Noten 226, 227, 532
Playlists 651
Sysex 721
umschalten 229
Velocity 707
Waveform 526



Pro Tools-Referenzhandbuch1360

Spurdarstellung, Umschalten 229
Spurdaten 524
Spureinstellungen in der Notationsdarstellung 766
Spuren 8

Anmerkungen hinzufügen 222
Arten 201
auf Zeitbasis-Leisten selektieren 584
aus Selektion entfernen 585
ausblenden 233, 234
Clips platzieren 849
Clips selektieren 578
Color Coding (Optionen) 250
Darstellungshöhe 230
deaktivieren/aktivieren 249
duplizieren 224, 1074
Elastic Audio 907
Formate 202
gruppieren 255
löschen 224
Master-Darstellung 230, 1107
Mehrkanalspuren in Monospuren 

konvertieren 1172
Metronomspur erstellen 431
mit Fast Forward/Rewind navigieren 410
Namen 219, 221
neue Elastic Audio-Spuren erstellen 908
neues Material am Ende hinzufügen 469
nicht benötigte Daten trimmen 604
Pegelanzeige 213
scharfschalten 442
Selektionen verschieben 584
soloschalten 246
Spuranordnung für das 5.1-Format 1171
Spurdarstellung 225, 229
Spurmaterial selektieren 577
stummschalten 249
Surround 1171
Tastenkürzel für Scrollen 591
transponieren 956
über mehrere hinweg selektieren 584
Video 1262
Wiedergabepriorität 242
wiedergeben 405, 457
zu Selektion hinzufügen 584, 585

Spurenanordnung
Standardpfadanordnung 80

Spuren-Darstellung
Master-Darstellung 1107

Spurenliste 232
Spurname (Befehle) 235

Spur-Offset-Optionen 362
Spur-Steuerelemente

Audiospuren 207
Auxiliary-Eingangs-Spuren 207
Edit (Fenster) 207, 208, 209
Instrumentenspuren 209
Master-Fader-Spuren 207
MIDI-Spuren 208
VCA Master-Spuren 208
Videospuren 209

SRC(Sample Rate Conversion)-Optionen 352
Standard

Abhörpfad 78
Ausgangspfad 78
Pegelanzeigenpfad 77
Pfadanordnung 80
Pfade 91
Program Change 716
Startzeit für Media Composer- 

Sequenzen 1320
Taktart 433
Tempo 434

Standard (Pfade) 91
Standard VCA Logic for Group Attributes 

(Option) 118
Standardeinstellungen, für TC/E-Plug-In 127
Standard-MIDI-Dateien 342

exportieren 344
importieren 342

Start To Insertion (Befehl) 604
Start, End und Length (Anzeigen) 461
Start-Frame (Sessions) 1205
Starting TC-Timecode (Einstellung)

an Session Start-Einstellung angleichen 1315
Startzeit für Media Composer-Sequenzen 1320
Statusanzeige für den Verzögerungsausgleich 176
Step Input (Befehl) 935, 962
Stereospuren

Clips ersetzen 861
Clips ziehen 611
Namen 440
splitten 610

Steuerelemente für Spuren
Elastic Audio 909

Stift-Tool 547, 572, 696
Stop (Schaltfläche) 180
Stop at Shuttle Speed Zero (Option) 131
Stottern 1313
Stotterndes Videobild 1313
Stretch (Befehl im Tempo Operations-Fenster) 818
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Strip Silence (Befehl) 866, 867, 868
Stummgeschaltete Clips und 

AudioSuite-Bearbeitung 897
Stummschalten

Clips 866
MIDI-Noten 707
Sends 1000
Spuren 249

Stummschaltungsautomation 1103
Subframes 1224
Submixe

Bounce auf Festplatte 1140
Insert anwenden 1019
Spuren soloschalten 1023

Sub-Zeitskala 795, 1212
Suchen nach Clips 272

neu hinzugefügte Clips einbeziehen 272
Suchen von Clips

nach Namen 272
Suchverlauf 273
Suppress Automation “Write To” Warnings 

(Option) 117
Surround

5.1-Formatpfade 1167
Einstellungsdateien 1163
grundlegendes Signal-Routing 1174
I/O-Einstellungen importieren 1165
Nebenpfade verwenden, Beispiele 1178
Panning-Raster 1186
Pan-Playlists und Automation 1197
Pfade verwenden 1177
Pro Tools konfigurieren 1163, 1171
Prozentsatz (%) für Center 1195
Prozentsatz (%) für Side 1196
Sends 1175
separater Pegel, Solo, Mute 1172

Suspend All Groups (Befehl im 
Groups-Listen-Popup-Menü) 258

Swing 940, 942
Symbolleistenfokus 28
Sync Point (Option im View-Menü) 863
Synchronisation 135

auflösen 1229
Black Burst 1229
Fehlerbehebung 1228, 1313, 1314, 1315
MIDI Beat Clock 423
MMC 1218
Optionen 1201

Synchronisationsgeräte-Einstellungen 136
Synchronisations-Voreinstellungen 130

Synchronisations-Peripheriegeräte 49
Sync-Offset 1208
SYNC-Peripheriegeräte

Sync-Optionen 1202
takten 1201
Timecode erzeugen 1217

Sync-Punkte 1228
aus Beat Detective 685
festlegen 862, 1228
für Clips 862

Sysex-Darstellung 721
System Exclusive-Daten

löschen 721
System Exklusive-Daten

verschieben 721
System Usage-Fenster 66, 67
Systemeinstellungen

Cache-Größe 57
Hardware Setup 60
Hardware-Puffergröße 52, 54
Host Engine 54
Playback Engine 53
Sample Rate 57
Taktgeber 60
Voice-Anzahl 56

Systemexklusive Daten 721
aufnehmen 494

Systemressourcen 16

T
T (Transfer – Übertragung) 286
Tab to Transients (Schaltfläche) 412, 587
Takes

abhören 472
alternative übereinstimmende Takes 472, 659
alternativen Take selektieren 472, 659
mehrere Spuren 473, 660
MIDI 493
Nummerierung für QuickPunch 502
Standardnamen 439
zusätzliche aufnehmen 467

Taktart
aktuelle 822
Anzeige 183
Standard 433

Taktart (Schaltfläche) 433
Taktart-Events

bearbeiten 823
einfügen 822

Taktart-Map 354
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Takte
neu nummerieren 830

Taktquelle 60, 1069, 1204
Target (Schaltfläche, Plug-Ins) 1048
Target Project Timecode Format 373
Task Manager 321, 334
Tastaturbefehle

Zahleneingabe 583
Tastaturfokus 26

Befehle 27
Clipliste 27, 275
Gruppenliste 27

Tastenkombinationen 1050
aufnehmen 458
globale Tastaturbefehle 26

Tastenkombinationen für Eingabe über 
Tastatur 1050

TC/E-Plug-In (Voreinstellung) 127, 560
TCE Edit to Timeline (Befehl) 622
TCE Trim-Tool 560, 561
Tempo

aktuell 799
Anzeige 183
Auswirkung auf Marker und Memory 

Locations 841
Manual Tempo-Modus 434
mit Tap-Funktion eingeben 435
Standard 434

Tempo Edit Density (Popup-Menü) 808
Tempo Editor 806
Tempo Operations (Befehle)

Constant (Befehl) 813
Linear (Befehl) 814
Parabolic (Befehl) 815
Scale (Befehl) 817
S-Curve (Befehl) 816
Stretch (Befehl) 818

Tempo Operations (Fenster) 812
Tempo Resolution-Selektor 807
Tempo Ruler Enable (Schaltfläche) 183
Tempo-Event-generierte Warp-Marker 919
Tempo-Events 799

Bar|Beat-Marker 820
bearbeiten 800
einfügen 800
Selektionen erweitern 809

Tempo-Event-Warp-Marker 804
Tempoleiste

anzeigen 799
Edit-Selektion erweitern 801, 845

Tempo-Map 354
Identify Beat (Befehl) 818

Thin All Automation (Befehl) 1100
Thin Automation (Befehl) 1100
Thinning von Automation 1080, 1099
Tickbasiertes Timing 795, 841
Time Compression/Expansion-Plug-In 622
Time Compression/Expansion-Trim-Tool 127, 560

MIDI trimmen 711
Time Grabber-Tool 566, 580
Time Lock für Clips 865
Time Operations (Befehle) 824

Change Meter (Befehl) 825
Cut Time (Befehl) 828
Insert Time (Befehl) 827
Move Song Start (Befehl) 829

Time Operations (Fenster) 822, 824
Time Slots-Anzeige 67
Time Stamp (Befehl) 280, 473, 659, 1227
Time Stamp Selected (Befehl) 858
Timebase-Leisten 791
Timecode 1315

Angleichung in einem Satellite-System 
erzwingen 1319

Drop-Frame-Beschränkungen in 
Pro Tools 1319

erfassen 1225
erzeugen 1217
Format anpassen 1319
Freewheel 1209
Position neu festlegen 1211
Startzeit-Offsets ausgleichen 1308, 1320
und Jam Sync 1209
zwischen ProTools und Satellite 

angleichen 1320
Timecode 2 Rate (Einstellung) 1205
Timecode 2-Leiste 792
Timecode Mapping (Optionen) 351
Timecode Mapping Options

beim Import 361
Timecode Rate (Einstellung) 1205, 1315
Timecode-Format 1315
Timecode-Markierung

Farbe einstellen 137
Größe 137
Horizontal Position 137
Vertical Position 137

Timecode-Zeitskala 792
Timeline Data Online Status (Anzeige) 176
Timeline Drop Order (Option) 850
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Timeline Insertion/Play Start Marker Follows 
Playback (Option) 108, 413, 421

Timeline- und Edit-Selektion, entkoppelt 575
Timeline-Selektionen 588

auf der Leiste verschieben 589
auf Zeitbasis-Leisten 588
aus Edit-Selektion kopieren 589
bei aktiviertem Playhead abhören 417
in Edit-Selektion kopieren 589
mittels Selector-Tool 565
Start, End und Length (Felder) 182
Timeline-Selektionsmarker 588

Timeline-Selektionsmarker 460, 576
Edit-Selektionen 577
Länge von Selektionen 581
Timeline-Selektionen 588

Tonhöhe (MIDI-Noten)
transponieren 703

Tonhöhe von MIDI-Noten
Transpose-Befehl transponieren 956

Touch Timeout (Option) 117
Touch Trim-Automationsmodus 1078
Touch/Latch-Automationsmodus 1077
Touch-Automationsmodus 1075
Track (Menü) 198

Auto Input-Monitoring-Modus 449
Clear All Clip Indicators (Befehl) 213, 214, 1005
Delete (Befehl) 224
Duplicate (Befehl) 224
Group (Befehl) 261
Input Only-Monitoring-Modus 449
Make Inactive (Befehl) 249
New Track (Befehl) 219
Scroll to Track 222
Set Record Tracks to Auto Input 450
Set Record Tracks to Input Only 450
Split Into Mono (Befehl) 610, 1172
Write MIDI Real-Time Properties (Befehl) 732

Track and Master Meter Types Linked (Option) 120
Track Color-Bedienfeld 994
Track Height 230
Track Name/Comments (Dialogfeld) 222
Track Number (Befehl) 222, 591
Track Offset (Optionen) 351
Track Position Numbers Stay with Hidden Tracks 

(Option) 105
Track View 225
Track View-Selektor 228
TrackInput Monitor (Anzeige) 181
TrackInput Monitor (Schaltfläche) 449

Track (Menü)
Duplicate (Befehl) 1074
Scroll to Track (Befehl) 591

TrackPunch
Crossfades 503
Voreinstellungen 504

Tracks (Befehl im Groups-Listen-Popup-Menü) 259
Track-Selektor 1046
Tracks-Liste

ausblenden 232
einblenden 232
Popup-Menü 232

Tragbarer Rekorder
monophone Audiodateien importieren 336
polyphone Audiodateien importieren 336

Transfer-Dateien 386
in Workspace auswählen 291

Transfer-Volume 283
Transponieren 956

Elastic Audio 930
MIDI-Noten 703, 956
Spuren 956
Tonart 957
um eine Oktave 958

Transport 179
Metronom 432
Taktart 433
Vorzählen 432

Transport (Fenster)
MIDI-Steuerelemente 182
Pre-/Post-Roll 181
Start, End und Length (Felder) 182
Transport (Steuerelemente) 179

Transport Master 1221
Transport Online (Option) 1216
Transport RecordLock (Option) 111, 504, 518
Transportable Rekorder

alternative Kanäle auf neue Playlists 
ausweiten 662

Transport-Darstellungsoptionen 182, 407, 461, 464
Transport-Fenster 179

Aufnahmestatusanzeige 507
Pre-/Post-Roll 464
Start-, End- und Length-Feld 461

Transport-Ziffernblockmodus 29, 109
Transpose

Real-Time Properties 731
Transpose (Befehl) 935, 956
Trim Automation (Befehle) 1126

Trim to All Enabled 1126
Trim to Current 1126
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Trim Clip (Befehle)
End to Fill Selection 605
End to Insertion 605
Start to Fill Selection 605
Start to Insertion 604
To Fill Selection 606
To Selection 604

Trim to All Enabled Automation (Befehl) 1126
Trim to Current Automation (Befehl) 1126
Trim-Automation

addieren 1112
Trimmen

Anfangs- und Endpunkte von Noten 704
Automations-Breakpoints 809, 1103, 1112
Clip-Gain-Breakpoints 616
Clips mit Scrub Trim-Tool 562
Clips um Nudge-Wert 606, 705
Clips zum Edit-Einfügepunkt 604
Crossfades 635
nicht benötigte Clip- und Spurdaten 604
Start- und Endpunkte von Clips 559

Trim-Tools 547, 559
Automationsdaten trimmen 1103
Clip-Gain trimmen 616
Loop-Trim-Tool 563
Scrub-Trim-Tool 562
Time Compression/Expansion-Trim-Tool 127, 

560, 711
Trimmen von Automationsdaten 809

Tweak Head-Einstellung (Konvertierungsqualität) 
1149, 1277

U
Übereinstimmungen (alternative Takes) 472, 659
Überlappende Crossfades 632
Übernahme (Surround-Pannen) 1191
Überschneidung bei Pfaden 95
Umbenennen

automatisch erzeugte Clips 277
Clips in der Clipliste 278
Clips in Spuren 533
Memory Locations 843
Playlists 647

Umgekehrt gekoppelte Panoramasteuerung 1011
Umschalten

Darstellungshöhe 230
Spurdarstellung 229

Undo (Befehl) 457, 535
Undo History-Fenster 536
Undo-Reihe 537
Ungroup All Clips (Befehl) 879

Ungroup Clips (Befehl) 879
Ungültige Zeichen 161, 387
Universe-Darstellung 592
Unlock Clip (Befehl) 864
Unloop Clips (Befehl) 875
Unterordner für Einstellungen erstellen 1054
Use Absolute Pan Linking (Option) 116
Use F11 for Wait for Note (Option) 128, 483
Use MIDI to Tap Tempo (Option) 128
Use Separate Play and Stop Keys (Option) 110
Use Subframes (Option) 1224
User Offset-Feld (+/–) 1026

V
VCA Master

Automation anzeigen 1132
Gruppen zuweisen 988
Kanalzüge 205
Spurart 201
Spur-Steuerelemente 208
Spurtyp 985

VCA-Master
löschen 1134
mischen 985
Steuerelemente 987

Velocity Trim-Tool 708
Velocity-Darstellung 707
Velocity-Werte (MIDI)

editieren 707, 952
Fades 952
mit Pencil zeichnen 708
skalieren 708, 952

Velocity-Werte, MIDI
Real-Time Properties 730

VENUE 144
VENUE Link 50, 144
Verbinden

externe Audiogeräte 1068, 1069
Verformte Clips (Elastic Audio) 525
Verknüpfte Medien 23
Verlaufs-Panning 1193
Verschieben

Bar|Beat-Marker 820
Clips mit Fades 639
Fades 638
Inserts 1045
Marker 844
MIDI-Noten 704
Programmwechsel 719
Sysex-Events 721
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Versetzen von Clips 853
Vertical Position (Einstellung) 137
Verwalten von Clips 277
Verwandte Takes

Separate Clip (Befehl) 601
Verzögerung

MIDI Track Offsets 724
Verzögerungsausgleich

auf automatisch auf Bypass geschaltete 
Spuren anwenden 501

Hardware-Insert 75
Hardware-Insert-Delays 75

Video
importieren 1273
Wiedergabe 1312

Video Engine (Option) 57
Video Format (Einstellung) 1315
Video Import Options-Dialogfeld 1275
Video Media (Optionen) 351
Video Online (Schaltfläche) 1263, 1265
Video Satellite

Einstellungen 1315
Fehlerbehebung bei Satellite- 

Verbindungen 1314
Media Composer 143, 1311
Pro Tools beenden 1314
Synchronisationsprobleme vermeiden 1315
verbinden 1314
Video Satellite-Offset 1309

Video Sync Offset (Befehl) 1288
Video Universe-Fenster 1284
Video Window (Befehl) 1282
Videoclipgruppen 1282
Videoclips 1278
Video-Engine-Rate 1272
Video-Engine-Rate-Anzeige 1272
Videofenster 1282
Video-Pull-Up und -Pull-Down 1213
Videospuren 202, 1262

als Block anzeigen 1264
Einstellungen 1265
Haupt-Videospur 1263
Output (Einstellungen) 1267
Projekttyp 1265
scrubben 1283
Shuttling 1283
sperren 1271
Spur-Steuerelemente 209
Videoqualität 1270

View (Menü) 198
Clip Name View (Option) 534
Clip Sync Point View (Option) 863
Clip Time View (Option) 534
Edit-Fenster (Ansichtsoptionen) 175, 992
Mix-Fenster (Ansichtsoptionen) 172, 992
Narrow Mix (Option) 219
Track Number (Befehl) 222, 591
Transport-Darstellung (Optionen) 182, 464
Transport-Darstellungsoptionen 407, 461

VITC
Generate Lines (Einstellung) 136
Read Lines (Einstellung) 136
Read Lines, Standard 136

VITC Insertion Enabled (Option) 136
Voices 500

Native-Plug-Ins 1039
Spurenpriorität 242

Voices-Anzeige 67
Voice-Selektor 242
Volume

Performance 283
Transfer 283

Volume-Berechtigungen 286
Voreinstellungen

ändern 105
DestructivePunch 504
DestructivePunch File Length 513
global 133
lokal 133
Mute Audio Inputs in Auto Input 520
Mute Record-Armed Tracks While Stopped 520
Plug-Ins 1053
Plug-In-Zuweisungen 1059
QuickInfo-Anzeigeoptionen 199
TrackPunch 504
während Wiedergabe anhalten 324
Zoom Toggle 115

Voreinstellungen (Preferences-Dialogfeld) 105
Vorgänge

angehalten 322
ausstehend 323
fehlgeschlagen 323
gruppiert 324
während Wiedergabe anhalten 324

Vorhören
Clips in der Clipliste 276
im Kontext 309
Reservieren von Voices 310
Voice-Anforderungen 310
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Vorlagen
Beat Detective 677
DigiGroove 677
ProTools-Session 169

Vorzählen 432

W
Wait for Note 183
Warp (Anzeige) 923
Warp-Darstellung 909, 917
Warpen von Audio mit Elastic Audio 920
Warp-Marker 918

hinzufügen 918
löschen 919
Position ändern (ohne Warping) 919

WAV-Dateiformat 388, 1144
mit AES31/Broadcast kompatibel 388

WaveCache 303
WaveCache-Datei (.wfm) 159, 283
Waveform View (Optionen)

Outlines 528
Peak 526
Power 527
Rectified 527

Waveform-Darstellung 526
Waveform-Darstellung (Optionen) 526
Wellenformen 526

Klick- und Knackgeräusche vermeiden 529
mit Pencil-Tool reparieren 572
Richtlinien zum Editieren 528
WaveCache 303
Workspace 303
Zero-Crossing 529

Werkseitige I/O-Einstellungen 100
Whole-File-Clips 525
Whole-File-Schaltfläche (AudioSuite) 895
Wide Meters-Bedienfeld 215
Wiedergabe

anhalten 405
Audio 405
halbe Geschwindigkeit 418
kein Scrollen 413
MIDI 406
starten 405

Wiedergeben
ab bestimmter Spurposition 409
Audio 405
Edit-Selektionen bei aktiviertem Playhead 417
MIDI 406
Selektionen 415

Selektionen vornehmen 579
Spuren 405, 457
Timeline-Selektionen bei aktiviertem 

Playhead 417
Wiederholen

Selektionen und Clips 871
Window (Menü) 198

Automation Enable (Befehl) 1085
Big Counter (Befehl) 407
Disk Space (Befehl) 445
Edit (Befehl) 175
Farbpalette 252
Machine Track Arming (Befehl) 1223
Memory Locations (Befehl) 843
Mix (Befehl) 172
System Usage (Befehl) 67
Task Manager (Befehl) 334
Transport (Befehl) 179
Undo History (Befehl) 536
Workspace (Befehl) 447

Windows-Sessions
Kompatibilität mit Mac 391

Word Clock 62, 1324
Workflows 518
Workspace 281

abhören 305
angehaltene Vorgänge 322
Anmerkungen 296
Automatically Find and Relink (Befehl) 313
Auto-Preview-Modus 309
Befehle 292
Browser-Anzeigeoptionen 292
Browser-Menü 290
Calculate Waveform 303
Datenbank 283
Datenbankelemente 294, 295
Datenbankelemente kopieren 297
Datenbankelemente löschen 297
Datenbankelemente verschieben 297
Elastic Audio-Analyse 304
Elastic Audio-Plug-In-Selektor 307
fehlende Dateien 310, 312
fehlgeschlagene Vorgänge 323
Find Links (Befehl) 316
geeignete Volumes (siehe 

Transfer-Dateien) 311
Indizieren 288
Kandidaten für Neukopplung 314
Kataloge 282, 318, 319
kopieren und neu koppeln 311
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Kopplungsoptionen 316
Links 310
Loop-Abhörmodus 308
Manually Find and Relink 313
Navigation 285
Performance-Volume 283
Regenerate Missing Rendered Files 

(Befehl) 313
Relink 310
Relink (Fenster) 282
Schnellsuche 298
Session 282
Skip All 313
Spalten sortieren 293
Suche als Katalog speichern 303
suchen 298
Task Manager (Fenster) 282
Transfer-Dateien 310, 311
Transfer-Volume 283
Volume-Berechtigungen 286
Volumes 282
Voreinstellungen 324
Vorgänge 322
Vorhören 306, 309
WaveCache 283
Wellenformanzeige 303

Workspace
Relink-Fenster 314

Workspace.wksp-Datei 283
Workspace-Browser 185, 281, 447, 448
Write 1125
Write Automation (Befehle) 1124, 1125
Write Automation To (Befehle) 1129
Write Automation To Next Breakpoint (Befehl) 1117
Write Automation To Next Breakpoint on Stop 

(Befehl) 1119
Write Automation To Selection/Selection 

Start/Selection End (Schaltflächen) 1114
Write MIDI Real-Time Properties (Befehl) 732
Write Trim-Automationsmodus 1079
Write-Automationsmodus 1074

X
XML (MIDI-Patch-Namen) 717
X–OR (Cancels Previous Solos) (Solo 

Latch-Option) 248

Z
Zahleneingabe

Tastaturbefehle 583
Zeitbasis-Leisten

Edit-Marker 576
Edit-Selektionen verschieben 586
Pre- und Post-Roll-Flags 576
Timecode 2 792
Timeline-Selektionen 588
Timeline-Selektionen verschieben 589
Timeline-Selektionsmarker 576

Zeitskala 794
Bars|Beats 791
Feet+Frames 792
Haupt-Zeitskala 794, 1212
Minutes:Seconds 792
Samples 792
Sub-Zeitskala 795, 1212
Timecode 792

Zeitstempel 377, 1226
Bounce to Disk 1142

Zentrierter Crossfade 626
Zero-Crossing 529
Zielordner für Plug-In-Einstellungen 1054
Ziffernblockmodi 28, 109

Classic 29, 109
Shuttle 30, 109, 572
Transport 29, 109
Use Separate Play and Stop Keys 110

Zoom Presets 554
Zoom Toggle 554
Zoom Toggle-Voreinstellungen 115, 554
Zoomen 548

alle Clips anzeigen 550
alle Spuren horizontal 548, 549
im Tempo-Editor 806
kontinuierlich 548, 549
mit dem Mausrad 558
Position in einer Spur 551
Selektion 550
Spurbereich 551, 757
um eine Position in einer Spur 756
verkleinern, um gesamte Session 

anzuzeigen 550
vertikal 549
Zoom Toggle 554
Zoom-Stufen aufrufen 554
Zoom-Stufen speichern 554
zur vorherigen Zoom-Stufe zurückkehren 550
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Zoomer-Tool 547, 548, 551
Zoomschaltflächen 548
Zu kopierende Elemente 167

Preserve Folder Hierarchy (Befehl) 168
Zufällig

Notendauer 956
Zufallswert

Notenpositionen 939
Zurück/Vorwärts-Wert 411
Zuweisen von Kanälen

Standardpfadanordnung 80
Zuweisung von Kanälen

bearbeiten 94
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